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Preface

Preface
This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications  

To nd guides for Oracle Applications, go to the Oracle Help Center.

Documentation Accessibility  

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Contacting Oracle  

Access to Oracle Support
Customers can access electronic support through Oracle Support. For information, visit Get Started with Technical
Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides. You can complete one of the following surveys:

• For guides: Oracle Service Cloud Documentation Feedback.

• For tutorials: Oracle Service Cloud Tutorial Feedback.

i

http://docs.oracle.com/
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
https://cx.rightnow.com/app/landing/get_started_support
https://cx.rightnow.com/app/landing/get_started_support
http://www.oracle.com/us/corporate/accessibility/support/index.html
http://documentation.custhelp.com/ci/documents/detail/5/4/12
http://documentation.custhelp.com/ci/documents/detail/5/3/12
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2  Core Features

Geing Started for Administrators  

Download the Oracle Service Cloud Client and Log In  
Oracle Service Cloud, the customer experience suite, delivers comprehensive customer experience applications that
drive revenue, increase eciency, and build loyalty. Download the client and log in to begin working in Oracle Service
Cloud.

After you download Oracle Service Cloud, all of the necessary components are automatically installed so you can begin
conguring and customizing your application immediately. However, before you get started, you will want to review the
system requirements and the environmental conguration information in  Answer ID 31 .

Note:  Cookies must be enabled on your workstation in order to work in the application.

1. Open your web browser and navigate to hp://your_site.custhelp.com/cgi-bin/your_interface.cfg/php/
admin/launch.php.

2. Click Install Oracle Service Cloud.
A security message warns you that the application should not be installed unless you know that it is from a
trusted source.

3. Click Install.
After Oracle Service Cloud downloads to your workstation, the Login window opens.

4. To view all deployment les and processes, click View Log File.
You can congure several login options for your application, including login help and Login window
customizations. Other login options can help you control and track login behavior. See Login Help Options.

5. Enter administrator in the Username eld.
You must enter this user name the rst time.

6. Enter the password assigned when your site was created. After logging in the rst time, you must change your
password. See Change Your Password.

User names and passwords are case sensitive. Keep this in mind as you add sta accounts. See Sta Accounts
Editor.

Tip:  The Interface eld displays the name of the interface from which you launched the installer.
This drop-down menu will also contain the names of any additional interfaces you install for this site,
beginning with the rst interface installed.

7. Click Login.

The Service Console opens after the system updates and loads all necessary support les.

Related Topics
• Install the Agent Desktop (video)

3
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Initial Setup  
Before you get started, it’s important to understand how navigation sets, proles, and sta accounts work together as
you initially congure your application.

The administrator login you used to download Oracle Service Cloud is a special account, meaning it is not a dened
sta account and has no prole or navigation set associated with it. Consequently, your access to functionality is limited
to the Analytics explorers, the administrator’s notications, and a default conguration list. This list contains essential
items for initially conguring your application so your sta can begin working.

Create Navigation Sets, Proles, and Sta Accounts  
Navigation sets control the navigation lists and buons that sta members see on the console navigation pane. No sta
members can work in your application without a navigation set.

You can create unique navigation sets for sta members who have any combination of responsibilities, such as working
with incidents, maintaining answers in your knowledge base, and creating mailings and surveys.
Sta members must also be associated with a prole to give them permission to add and edit reports, records, and
other items. You can create as many proles as you need based on the areas that sta members will work in and the
functionality they need to access. When you create proles, you must assign a default navigation set to each prole.

Note:  It’s important to consider the security of your site when granting sta members permissions. See
Administration Interface Conguration for information about protecting your site when assigning sta
member prole permissions. To learn how you can develop a security plan that ts the needs of your
organization, see How You Develop a Security Plan.

The nal element all sta members need is a sta account, which contains the login information they’ll need to access
the application. Congure the initial setup for your sta in this order:

1. Create navigation sets consisting of navigation buons and their associated navigation lists.
2. Create proles and assign a navigation set to each prole.
3. Create a sta account for each sta member and assign a prole to each sta account.

Since you need access to all functionality, the rst navigation set and prole you’ll create is your own (see
Create a Navigation Set for the Administrator). Then, add a sta account for yourself and begin using your new
login information.

Tip:  If you intend to use custom workspaces instead of the default standard workspaces, you might
want to create your custom workspaces before creating proles, since you assign the workspaces sta
members use in their proles. If you decide to create your proles and sta accounts rst, you can
always update proles later with the custom workspaces. See Overview of Workspaces.

Related Topics
• Overview of Navigation Sets

• Proles

• Sta Accounts Editor
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How You Determine the Functionality Your Organization Needs  
In order to congure your application with all the functionality your organization needs, it makes sense to identify those
needs before creating your own navigation set.

While you can update any navigation set after you create it, we recommend doing it beforehand to save time and work.
Answers to the following questions can help determine what additional functionality beyond the defaults you want to
use. If you answer Yes to any question, contact your Oracle account manager to enable the product or component.

• Do you plan to use Oracle RightNow Outreach Cloud Service (Outreach) to communicate with your customers
through mailings and campaigns and Oracle RightNow Feedback Cloud Service (Feedback) to survey your
customers and prospects? If Yes, enable Outreach and Feedback. See Overview of Mailings, Overview of
Campaigns, and Overview of Surveys.

• Do you want your sales sta to be able to manage and track all opportunity and related organization and
contact information, and track quote interactions sent to customers and prospects? If Yes, enable Opportunity
Tracking. See Overview of Opportunities and How You Manage Quotes.

• Do you want your customers to interact with one another and your sta from a single location? If Yes, leverage
the peer-to-peer support using Community Self Service in Oracle RightNow Customer Portal Cloud Service. See
Overview of Community Self Service.

• Do you want your sta to be able to monitor conversations taking place on the social web regarding your
organization and its products and services? If Yes, enable Oracle RightNow Social Monitor Cloud Service (Social
Monitor). See Overview of Social Monitor.

Those products that are not enabled by default, Outreach and Opportunity Tracking, must be enabled in order for
certain items to appear in the default list of conguration items for the administrator special account. For instance, if
you want tracked link categories and the external suppression list to appear in your list of conguration items, contact
your Oracle account manager to enable Outreach before you start this procedure. Likewise, if you want the product
catalog, price schedules, strategies, quote templates, territories, and sales periods in your list of conguration items,
Opportunity Tracking must be enabled. If you create navigation sets before Outreach and Opportunity Tracking are
enabled, you will have to manually add those items to the list of conguration items for the Conguration buon after
the products are enabled.

Additionally, Feedback is not enabled by default, and while there are no conguration items associated with Feedback, it
must be enabled in order to access the Surveys and Questions explorers and create questions and surveys.

Create a Navigation Set for the Administrator  
Your navigation set must contain all the navigation buons you want to access. For instance, if you want to add and edit
incidents, add the Incidents buon to your navigation set and select the reports you want associated with this buon.

Your navigation set will include the Conguration buon, which will contain the conguration items you’ll need to
congure and customize your application. We focus on adding items to the Conguration buon in this procedure, but
the same steps apply when adding reports and other items to any navigation buon you want in your navigation set.
See Overview of Navigation Sets.

1. Log in to your application using the special administrator account.
2. Click Conguration on the navigation pane.

The default list of conguration items displays.

5
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3. Expand Application Appearance, and then double-click Navigation Sets.
The Navigation Sets explorer opens.

4. Click New.
The Navigation Sets editor opens.
Notice that File Menu displays rst in the list. While this is not a navigation buon, it is part of every navigation
set, and you can congure it with the items you want to be able to create from the le menu (accessed by
clicking File next to the Home tab on the ribbon).

Keep in mind, however, that you must also have the corresponding permission in your prole for every item or
record type you add to this menu. See Congure the File Menu.

5. On the content pane, scroll and select Conguration in the list of buons.
The folders display containing default conguration items associated with the Conguration buon for the
administrator special account.

6. Expand each folder to view its items.
File Menu will always appear rst in the list, but since it isn’t a buon that appears on the navigation pane, you
can move the Conguration buon under the File Menu and it will appear rst on the navigation pane. Just
click the buon in the top portion and then click Move Up to position it where you want it in the list.

7. On the left side of the content pane, click the plus sign next to Components to expand the list of conguration
items.

8. Expand the Common and Service subfolders.
Items appear in alphabetical order.
Note that Outreach and Opportunity Tracking folders don’t appear in the default list. In order for them to
appear, they need to be enabled before you create your navigation set. Contact your Oracle account manager.

Folder/Conguration Item Description

Sta Management This folder contains options to congure your application for proles, sta accounts,
 and password requirements.

Sta Accounts by Group This report lists your organization’s sta accounts by group. See Add or Edit a Sta
Account.
When you access any report in this folder, you can double-click a sta account (or
prole in the Proles report) to open it or select one and click Open. You can also click
New to add a sta account or prole, depending on the active report.
 

Sta Accounts by Manager This report lists sta accounts by manager.

Sta Accounts by Prole This report lists sta accounts by prole.

Logged In Sta Accounts This report lists the sta members who are currently logged in. You can use this report
to manage your desktop user sessions. See Log Out a Sta Member Manually.

Proles This report lists all proles in your application. From this report you can add proles that
dene the permissions sta members need to congure areas in your application and
work with reports, records, and components. See Proles.

Password Conguration Dene requirements for password expiration, number of invalid logins allowed, and
password length for sta accounts. See Congure Sta-Member Passwords.
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Folder/Conguration Item Description

Tip:  If you intend to require sta members to have a password to log in to the
application, you must congure your organization’s password requirements
before adding sta accounts.

Application Appearance This folder contains options to customize the information that is displayed to sta
members, determine what navigation buons and navigation lists sta members can
access, create images for workspaces, and customize your application with tools to
ensure that your knowledge base contains accurate and consistent data.

Workspaces Create custom workspaces to dene the way elds, tabs, buons, and reports display
on the content pane when working with records (answers, assets, contacts, incidents,
 opportunities, organizations, and tasks) and when working in Oracle RightNow Chat
Cloud Service (Chat). You can also create custom workspaces for the Quote, Quote
Product, and Service Opportunity windows. See Overview of Workspaces.

Client Workow Images Create images to use in workspaces and in questions for guided assistance. See Images
Explorer.

Navigation Sets Create navigation sets containing the navigation buons and associated navigation lists
sta members can access. See Create a Navigation Set.

Customizable Menus Create menu items to keep your knowledge base organized and up-to-date. See
Overview of Customizable Menus.
By default, the Customizable Menus tree contains a System Menus folder, consisting
of default menu items, and a Custom Menus folder, which will contain the menu-only
custom objects you create. If you disable the custom objects feature before creating
your navigation set, the tree will not contain any folders and only the default menu
items will be listed in the tree. See Menu-Only Custom Objects.
 

System Menus Customize any of the following default menu items in this folder.
When Opportunity Tracking and Chat are enabled, this list will also contain the following
items.
 

◦ Opportunity Tracking—Competitors, Contact Roles, Industry Types, Lead Rejection
Types, Opportunity Statuses, and Win/Loss Reasons

◦ Chat—Chat Agent Statuses and Chat Queues

◦ Answer Access Levels Add custom answer access levels to control what information is visible to sta members
and customers on each interface. The two default answer access levels are Help and
Everyone. See Add or Edit an Answer Access Level.

◦ Answer Statuses Add custom answer statuses to control which public answers are visible to customers
and sta members. The four default answer statuses are Private, Proposed, Public, and
Review. See Add or Edit an Answer Status.

◦ Asset Statuses Add custom asset statuses to more accurately represent the status of assets (products
and services) registered and tracked in your application. The default asset statuses are
Active, Retired, and Unregistered. See Add or Edit an Asset Status.

7
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Folder/Conguration Item Description

◦ Billable Tasks Add billable tasks so you can record the time agents spend working on incidents. The
default billable task is Miscellaneous. See Add or Edit a Billable Task.

◦ Channel Types Congure your application so you can store your contacts’ Twier, YouTube, and
Facebook user names in their contact record. When user names are available, incidents
created from these channels are associated with the appropriate contact, giving
agents a more complete understanding of all incidents submied by each contact. See
Overview of Channels.

◦ Contact Types Add contact types to organize the contacts in your knowledge base into classications,
 such as a contact’s position or function with respect to your organization. See Add or
Edit a Contact Type.

◦ Incident Queues Add incident queues to automatically route incoming incidents when used with business
rules. Adding incident queues lets you also control which incidents agents work on, the
order incidents are worked on, and how many incidents agents can have in their inbox at
one time. See Add or Edit an Incident Queue.

◦ Incident Severities Add incident severity levels to record the importance or urgency of individual incidents.
See Add or Edit an Incident Severity Level.

◦ Incident Statuses Add custom incident statuses to show a more complete representation of the state
of incidents in your knowledge base. The four default incident statuses are Solved,
 Unresolved, Updated, and Waiting. See Add or Edit an Incident Status.

◦ Organization Address Types Add organization address types to store multiple addresses for the organizations in your
knowledge base. The default address types are Billing and Shipping. See Add or Edit an
Organization Address Type.

Custom Menus While this folder is initially empty, it will contain any menu-only custom objects you
dene for your application. Using menu-only custom objects, you can store options for
populating menu elds in other custom objects. You can then use the same menu lists
to populate menu elds in multiple custom objects. See Menu-Only Custom Objects.

Site Conguration This folder contains options to congure and customize all elements of your interfaces.

Interfaces Change the display name of the interface (see Change the Interface Display Name) and
identify the answers report that displays on your customer portal (see Overview of the
Answer and Question Details Pages).
When Chat is enabled, the ribbon on the Interfaces editor contains a Chat Hours buon
for seing the hours your agents are available to chat with customers. See Overview of
Chat.
 

Message Templates Customize your Oracle RightNow Cloud Service (Service) email, including messages
used in administrator notications and emails and in contact emails. You can also
standardize the look and feel of all your outgoing email to present a unied image to
your customers. See How the Message Templates Editor Works.

Contact Password Conguration Set requirements, such as minimum password length and the maximum number of
character repetitions and occurrences allowed, to strengthen customer passwords when

8
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Folder/Conguration Item Description

accessing your customer portal. See Conguring Oracle Service Cloud for Customer
Portal.

Mailboxes Add Service and Outreach mailboxes (when Outreach is enabled) and customize
mailbox seings. You can congure both outgoing and incoming email options. See
How Mailboxes Work.
If Oracle has added an Oracle-managed Service mailbox for your application, you can
edit some of the seings associated with this mailbox, while other seings are read-
only. See Edit an Oracle-Managed Service Mailbox.
 

Distribution Lists Add mailing lists consisting of non-sta members’ email addresses. See Add or Edit a
Distribution List. Distribution lists can also be used to schedule and send reports. See
How You Schedule Reports.

Rules Congure your application with business rules to automate workow and handle routine
tasks. See Create a Rule Base.

Conguration Seings Customize conguration seings for each interface. See How You Customize
Conguration Seings.
When you change a conguration seing, you must log out and log back in for the
change to take eect.
 

Message Bases Customize the headings, labels, and text on the administration interface and your
customer portal. See How You Customize Message Bases.

File Manager Modify Chat images, custom scripts, wordlist les, dictionary les, and certicate
directories. See Manage Files with the File Manager.

Add-In Manager Upload add-ins and allow access to individual add-ins for each prole and interface. See
Install a New Add-In.

Logs View the error log, info log, security log, and the external search log. You can also access
the rule log from this option. See Log File Errors and Information.

Process Designer Create custom processes (object event handlers) that run when events occur on objects
in Oracle Service Cloud. See Process Designer.

Internationalization This folder contains an option to congure your application with the countries in which
you do business.

Countries Add countries and provinces to maintain accurate address information for the
organizations and contacts in your knowledge base. See Add or Edit a Country or
Province.

Service This folder contains conguration options specic to Service.

Knowledge Base Congure options so search results are more eective for customers when searching for
answers and to broaden the scope of search capabilities for both customers and sta.

9
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External Search Conguration Congure the Web Indexer to index and search documents that are not part of your
knowledge base (for example, web pages and entire websites). See Overview of Finding
Content on the Customer Portal.

Answer Stopwords View or change the list of stopwords for answers that will be excluded from indexing and
searching. See Conguring Oracle Service Cloud for Customer Portal.

Search Priority Words Create words that are associated with a public answer or a web document that will
always display when the word is included in the search text. See Conguring Oracle
Service Cloud for Customer Portal.

Topic Browse Test the cluster groups for the Browse search method or schedule clustering for the next
run of the Agedatabase utility.

Incident Stopwords View or change the list of stopwords for incidents that will be excluded from indexing
and searching. See Add or Edit an Incident Stopword.

Service Level Agreements Track the eectiveness of your customer service and control the service and support
you provide to your customers.

Response Requirements Dene the time (in minutes) that agents have to initially respond to incidents and the
time (in minutes) allowed to solve incidents. By dening response requirements, you
can monitor how agents are meeting your organization’s service goals. See Overview of
Service Level Agreements.

Service Level Agreements Create SLAs (service level agreements) to assign to the contacts and organizations in
your knowledge base. You choose the duration of each SLA, the number of incidents
that can be submied through the SLA, and the response requirements based on the
support you want to oer customers. See Overview of Service Level Agreements.

Holidays Add all the holidays your organization observes, per interface. Response requirements,
 including any custom response requirements you have created, are suspended during
holidays. See Overview of Service Level Agreements.

Products/Categories/Dispositions Add service products and categories to group the answers and incidents in your
knowledge base. You can add products and categories to each interface you have
congured as well as add additional levels of products (subproducts) and categories
(subcategories).
Add dispositions to record how incidents were resolved (what was done for the status to
change to Solved). You can add up to six levels of dispositions and require that agents
select a disposition before an incident’s status can change to Solved.
 
Link products to categories and products to dispositions so that only the categories and
dispositions that have been linked to a product appear when the product is selected on
the administration interface or your customer portal.
 
See Search Optimization Using Products, Categories, and Dispositions and Product
Linking.
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Standard Text Dene text and responses for agents to insert when responding to incidents or engaged
in chat sessions, or to add as a business rule action. When you dene standard text, you
designate where it will be available to sta: Incident Text and Rule Text. See Overview of
Content Library.
When Chat is enabled, Chat Text and Chat URL options are also available.
 

Variables Dene shortcuts instead of entering long strings of text. Variables can be inserted in the
Question and Answer elds of answers or inline when responding to customers during
a chat. When customers view the answer or receive a response from an agent during a
chat, the variable is replaced with the value you dene. See Overview of Content Library.

Channels Customize all the channels customers use to communicate with your organization,
 including the standard channels through which incidents are created (Service Email,
 Outreach Email, Phone, Fax, Post, Service Web, Outreach Web, Chat, and Email) as
well as the social channels (Twier, YouTube, RSS, and Facebook). You can also create
custom channels for RSS, and Facebook. The remaining standard and social channels
can be edited, including updating their name and disabling them. See Overview of
Channels.
Social Monitor must be enabled in order to monitor the social channels.
 

Channel Accounts Congure your application so sta members can respond to contacts through Facebook
or Twier. Without a channel account, your sta can respond only through email. See
Overview of Channels.
Social Monitor must be enabled in order to create a channel account for communities.
 

Database This folder contains options to add and update items in your database to ensure the
information is complete and up-to-date.

Data Dictionary View a list of all the tables in the Oracle database and all columns in each table. See View
Your Database Data Dictionary.

Custom Fields Gather additional information about answers, contacts, incidents, opportunities,
organizations, quotes, sales products, sta accounts, and tasks. See Custom Field Types.

Object Designer Create custom objects in order to integrate your organization’s data with Oracle Service
Cloud. You can manage and report on the data in the same way you manage and report
on incidents, answers, contacts, tasks, and other standard objects. See Custom Object
Types.
If you disable the custom objects feature before creating your navigation set, the Object
Designer will not display in the default list.
 

Incident Thread Correction Convert an incident response thread into a note thread. Note threads are never seen by
customers in their incident responses.
If you have Edit/Delete Commied Thread Content permission set in your prole, you
can edit incident thread content, including deleting images.
 
See Edit or Convert a Response Thread.
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Data Import Templates Add data import templates to map columns in a CSV le to columns in your database.
You can then skip the column mapping process when uploading records from a CSV le
with the same column ordering. See Add or Edit a Data Import Template.

Data Import Wizard Upload multiple records using the Data Import Wizard. See How Data Import Works.

Email Address Sharing Enable email address sharing so a group of related contacts (such as a family or a team)
can maintain individual contact records while sharing one email address. See Email
Address Sharing.

9. Select the conguration item and click Add. You can also drag the item and place it where you want it in the list
or double-click the item.

a. To add more than one item at the same time, press Ctrl while selecting each item and click Add.
b. To search for a specic item to add, click Find in List. This feature also locates items in folders that aren’t

expanded.
10. To set an item as the default for the conguration list, right-click it and select Set As Default.

The item you set as the default will automatically open on the content pane when the conguration list displays
when you log in.

11. To remove an item from the conguration list, select it and click Remove.
12. To group your items into more categories than currently exist in the conguration list, click New Folder.

a. Enter the name of the folder.
b. Drag items to the folder.

13. To rename a folder, including one of the default folders, right-click it and select Rename. Then enter a new
name.

14. To move an item in the list, select it and click Move Up or Move Down, or drag it where you want it in the list.
15. To create a navigation list for each type of record and item that you want to be available in your navigation set

(such as answers, incidents, contacts, and organizations), repeat the previous steps.
The check box next to each buon is selected by default. To remove a buon from your navigation set, just
clear its check box.

16. To add items to the le menu so you can use this shortcut to add records and items to the knowledge base,
scroll to the top of your list and click File Menu. See Congure the File Menu.

17. Click Save.
The Save As window opens.

18. Enter a name for the navigation set in the Navigation Set Name eld and click OK.

Next, create a prole with full administration permissions and associate your navigation set with this prole. Then add
your sta account assigned to the full access prole. Thereafter, use your sta account information (name entered in
the Username eld and password, if you dene one) to log in. See Proles and Sta Accounts Editor.

Tip:  There’s another way to customize your conguration list or any navigation list after you create your
navigation set. With the Customize Navigation Sets permission in your prole, you can add items to a list
directly from the navigation pane (by clicking the Gear buon in the Conguration list). When you add items
this way, you are changing only your lists, not the original navigation set. See How You Customize Navigation
and Conguration Lists. To examine the implications of customizing your navigation set from the navigation
pane, see Overview of Navigation Sets.
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Related Topics
• Proles

• Sta Accounts Editor

• Change Your Navigation Pane Seings

Optional Conguration Items  
There are several optional conguration items you may want to enable.

Although Oracle Service Cloud contains a default conguration list for the special administrator account, there are
more items you can add to your conguration list depending on what functionality you want. However, the majority of
the items won’t be available for you to add until the associated product or component is enabled. Contact your Oracle
account manager to enable products and components listed in this section.

The following table describes the items that display under Components after their associated product or component
is enabled. The alphabetical list is organized in folders: Analytics, Audiences, Common, Content Library, Feedback,
Opportunity Tracking, Outreach, and Service items. Unless specically noted, all items appear in the default
conguration list if you enable the product or component before creating a navigation set. Otherwise, you must
manually add the item to your conguration list.

Folder/Item Description

Analytics The Analytics folder contains all Analytics explorers and the Report Management item.
The Analytics explorers are available to you with your special administrator account from the Analytics
buon on the navigation pane. In addition, the Analytics navigation buon is part of new navigation
sets, and you can add any Analytics explorers to this buon for your own navigation set or any of the
other navigation sets you create. See Create a Navigation Set.
 

Explorers Analytics explorers include Chart Styles, Color Schemes, Images, Reports, Styles, and Text Fields.

Report Management Manage reports more easily and gain insight into where and how reports are being used in your
application. Using the Report Management item, you can identify certain types of reports to help make
system and report maintenance easier.
This item does not have to be enabled, but you must manually add it to your navigation set. You can
add it to the Analytics buon, the Conguration buon, or any other navigation buon.
 

Audiences The following conguration items appear in the Audiences folder after you enable Outreach and
Feedback.

Contact Lists Explorer Add the Contact Lists explorer to a navigation list in order to access and create static lists of contacts
for use in mailings and surveys. You must manually add this explorer to one of your navigation lists or
the conguration list. See Overview of Audiences.

External Suppression List Add a list of email addresses that will be excluded from mailings.
The External Suppression List displays in the Outreach folder in the default conguration list if you
enable Outreach before creating your navigation set.
 

Segments Explorer Add the Segments explorer to a navigation list in order to access and create dynamic lists of contacts
for use in mailings and surveys. You must manually add this explorer to one of your navigation lists or
the conguration list.
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Common Common items apply to all products: Feedback, Opportunity Tracking, Outreach, and Service.

Access Control Add Access Control to a navigation list in order to dene community users’ access to the community.

Currencies/Exchange Rates Add currencies for all the countries in which you do business and add exchange rates for each currency
so your sales representatives have up-to-date rates when sending quotes to customers. See Add or
Edit a Currency.
This item appears in the Internationalization folder in the default conguration list if you enable
Opportunity Tracking before creating your navigation set.
 

Customer Portal Access the Customer Portal Administration site to perform administrative tasks, including staging and
deploying your customer portal pages.
You must enable MOD_CP_DEVELOPMENT_ENABLED in Common/Oracle Products/
Modules in order to make changes to your development site. If you do not enable this seing, you
cannot make changes to your customer portal, and your customers will see the default reference
implementation with no customization.
 

Engagement Engine Rules Create rules to give your organization greater control over where, when, and how proactive and
reactive chats are provided to your customers.
After this component is enabled, you must manually add it to your list of items for the Conguration
buon.
 

Language Skills Add language skills to your application so you can route incoming chats to the agent with the most
appropriate skill set.
Chat and Smart Interaction Hub must be enabled before you can add this item to your conguration
list. Contact your Oracle account manager.
 

Product Skills Add product skills to your application so you can route incoming chats to the agent with the most
appropriate skill set.
Chat and Smart Interaction Hub must be enabled before you can add this item to your conguration
list. Contact your Oracle account manager.
 

SA Auto Tuner Fine-tune SmartAssistant to provide more relevant results to your customers and help reduce the
incidents submied to your support site. In addition to improving incident deection rates, information
produced by the autotuning feature can be useful for rening the knowledge base and providing
guidance to agents.
You must enable KF_SA_OPTIMIZATION_ENABLE and manually add this component to your list of
items for the Conguration buon.
 

Scripts Explorer Create scripts for workspaces that can contain elds and controls and branching logic to guide agents
to dierent pages based on actions they take on a script page.
This item appears in the Application Appearance folder if you enable agent scripting before creating
your navigation set.
 

Service Update Notications View changes that have been made in this version that may aect your organization if you are
updating from an earlier version. You can view compatibility exceptions and deprecations and make
changes inline to help you track how service updates aect your site. See Service Update Notications.
This component does not have to be enabled, but you must manually add it to your list of items for the
Conguration buon.
 

Single Sign-On Congurations Administer single sign-on (SSO) integrations with external applications that reside outside Oracle
Service Cloud. Single sign-on integrations let you use Oracle Service Cloud as an identity provider
to store and authenticate customer credentials. After conguring an SSO service provider and
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application, sta members can then access the external application without being asked for their login
credentials. See Set Up Single Sign-on (SSO) Using an External Identity Provider.
This component does not have to be enabled, but you must manually add it to your list of items for the
Conguration buon.
 

Virtual Assistant Editor Route incoming chats to a simulated agent that uses knowledge base data to respond to customer
questions. Virtual assistant chats can ease the volume of chats requiring an agent.
Your site must be integrated with Oracle RightNow Virtual Assistant Cloud Service in order to use a
virtual assistant.
 

Workspaces/Workows When the desktop workow feature is enabled, Workspaces changes to Workspaces/Workows in
the Application Appearance folder. No action on your part is required. You can then create desktop
workows that can be used in place of a single workspace for each editor.

Content Library When Outreach or Feedback is enabled, this folder displays in the list of conguration items and
contains Documents, File Aachments, Snippets, Templates, and Tracked Links explorers. You’ll
use these explorers to access and manage mailings, campaigns, questions, surveys, audiences, and
content library items (documents, le aachments, snippets, templates, and tracked links).
The Content Library navigation buon also appears in a new navigation set when Outreach or
Feedback is enabled, and you can add these explorers to the Content Library buon (or any other
buon in new navigation sets).
 

Feedback When Feedback is enabled, this folder displays in the list of conguration items and contains the
Questions and Surveys explorers.
The Surveys navigation buon also appears in a new navigation set when Feedback is enabled, and
you can add these explorers to the Surveys buon (or any other buon in new navigation sets).
 

Opportunity Tracking The following items appear under Opportunity Tracking after Opportunity Tracking is enabled.

Price Schedules Add price schedules to assign to your sales products. You can add multiple price schedules for greater
exibility when sending quotes to customers. See Add or Edit a Price Schedule.

Product Catalog Add your organization’s sales products for use with quotes in Opportunity Tracking and Oer Advisor
in Service. See Add or Edit a Sales Product.

Promotions Add promotions to oer to customers and automatic recommendations based on customer aributes
and purchase history. You can also add target rules, which dene groups of customers called targets,
 for use in promotions and product suggestions.
Oer Advisor must be enabled before this item will be available. If enabled before you create your
navigation set, Promotions will appear in the Opportunity Tracking folder in the default list for
the special administrator account. If enabled after you create your navigation set, you will need to
manually add it to your list.
 

Quote Templates Add quote templates and organize them into folders to automate and standardize quote generation.

Sales Periods Add sales periods to track how sales representatives are meeting their sales quotas.

Strategies Add strategies to track your sales processes. Also add the stages and tasks specic to each strategy.

Territories Add territories and assign each sales representative to a territory for opportunity assignments. You can
add additional levels of territories (subterritories) to cover all the geographical areas in which you do
business.

Outreach The following conguration items appear in the Outreach folder after Outreach is enabled.

Campaigns Explorer The Campaigns explorer also displays in the Outreach folder.
The Campaigns navigation buon appears in new navigation sets when Outreach is enabled, and you
can add this explorer to the Campaigns navigation buon (or any other navigation buon).
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Mailings Explorer The Mailings explorer also displays in the Outreach folder.
The Mailings navigation buon appears in new navigation sets when Outreach is enabled, and you can
add this explorer to the Mailings navigation buon (or any other navigation buon).
 

Tracked Link Categories Add tracked link categories to group and classify your tracked links so your sta can quickly nd
particular tracked links. You can also generate reports to evaluate their eectiveness.

Service Optional items in this folder apply to Service.

Archived Incidents Access outdated incidents that have been removed from your knowledge base.
This item does not have to be enabled, but you must manually add it to your list of items for the
Conguration buon.
 

Guided Assistance Explorer Congure your application with an alternate search method for agents to quickly nd information
when working with customers on the phone or when responding to an incident and for customers
when searching for answers on your customer portal.
This item appears in the Service folder if you enable guided assistance before creating your navigation
set.
 

Incident Thread Masking Automatically mask incident thread content that matches certain common paerns, such as credit
card, social security, and telephone numbers. You can also dene up to ve custom paerns that will be
masked from view when new thread entries are created.
Incident thread masking must be enabled for this item to be available. When enabled, you can add it to
your list of items for the Conguration buon. Contact your Oracle account manager to enable incident
thread masking.
 

Social Monitor Interact with your customers by searching social media services, create incidents in Service, and
include social media in your Outreach and Feedback messages.
Social Monitor must be enabled for this item to be available. When enabled, the Social Monitor buon
appears in a new navigation set, and you can add this item to the Social Monitor navigation buon.
 

Note:  Conguring your application so your sta can work in Oracle Service Cloud is an important rst step in
the setup process. Another important element is managing sta sessions for site security and desktop usage
metering and licensing compliance. See Overview of Session Management and Login Controls to learn about
your options.

Open a Conguration Item  
Before you begin customizing your site, it’s a good idea to look at the key elements on the console from the perspective
of customer service agents, sales representatives, and marketing personnel.

1. Click Conguration on the navigation pane.
The conguration list displays.

2. Double-click an item in the list. The item tree displays on the content pane.
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The tree displays the text and responses dened for your application. Some conguration items, including
standard text, can be organized in folders. If the conguration item contains folders, as the standard text item
does in our example, you can expand all of them by clicking the arrow in the tree.

You can also add folders to custom elds across all products, variables in Service, and the product catalog and
quote templates in Opportunity Tracking.

Tip:  Tabs on the content pane display all of the items you currently have open. When more than one
item is open, just click a tab to return to that item or right-click a tab and select from the following
options: Open in New Window, Close, Close All But This, and Close All. You can also press Ctrl+W or
Ctrl+F4 to close the active tab or click Close (X) on any content pane tab. See Close Multiple Records
Simultaneously.Right-click options dier for records in a workgroup. When you right-click the content
pane tab of the primary record, your only option is to close all associated records in the workgroup.
When you right-click an associated record that is the active tab, your options include Accept Changes,
Cancel Changes, and Undock. See Record Workgroups. On administration editors, you can undock
any editor by clicking Undock on the active tab. This action opens the editor in a separate window and
allows you to move between the window and console without having to close the window rst.

3. To expand a single folder in the tree, click the arrow to expand the folder contents.
4. To change the name of a folder, click the folder.

To quickly locate an item in the tree, click the Search arrow. The search menu displays.

You can search by whole word or case and also search the list from the boom up. If your tree contains folders,
results will return a folder matching the text you enter. Clicking Next returns any items within the folder that
contain the search text.

5. To edit one of the standard text entries, click it in the tree. The editor displays the elds for the standard text.
a. Make any changes you want and click Save.

This saves your changes and leaves the editor open.
b. To save your changes and close the editor, click Save and Close.

Note:  If another sta member makes changes to the same entry and saves it before you save your
changes, you will receive a message to refresh or reload the editor in order to view the most current
data.

6. To add a standard text entry, click New. Your new entry displays in the active folder.

Action Description

Add a folder Right-click in the tree and select New Folder or right-click a folder to add a subfolder.

Add an item Click New. The editor opens.

Delete folders and items To delete a folder, right-click it and select Delete. Be aware that when you delete a folder,
all items in the folder are also deleted.
To delete an item, select it and click Delete. The item is removed from the knowledge
base.
 
If the item you want to delete contains sub-items, you must delete the sub-items rst.
Sub-items can be added to those conguration items that oer additional levels of
functionality. This includes products, categories, and dispositions in Service; tracked link
categories in Outreach; and territories in Opportunity Tracking.
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Expand and collapse folders Click the arrow in the tree to expand all folders, and click it again to collapse them.
To expand or collapse a single folder in the tree, click the arrow to expand or collapse the
folder contents.
 

Edit an item Click an item in the tree. The item information displays on the editor.

Reorganize folders and items Drag an item and drop it in the new position. When you move a folder, all items in the
folder also move. You can reorder within a folder or move items to another folder. You
can also drop a folder onto another folder to create a hierarchy.

Save folders and items To save a new folder or item or save changes to an existing item and remain on the
editor, click Save.
To save a new folder or item or save changes to an existing item and close the editor,
 click Save and Close.
 

Search the tree Click the Search arrow to display a menu for searching folders and items.

Related Topics
• Folders and Items in the Tree

• Available Actions from a Navigation or Conguration List

• Overview of the Service Console

• Add Folders

Add Folders  
Folders and subfolders provide a way to organize items in Service Cloud.

Certain conguration items can be organized in folders (custom elds across all products, standard text and variables in
Service, and the product catalog and quote templates in Opportunity Tracking).

Adding folders gives you more exibility in organizing your data. For instance, you might want to add a folder for each
type of sales product your organization sells or add folders to organize your quote templates by quote types. And after
you add folders, you can move them in the tree to create the hierarchy you want.

1. Double-click the item in the conguration list.
The tree of the item displays on the content pane.

2. Right-click in the tree and select New Folder.
The Folder editor opens and a New Folder entry appears in the tree.

3. Enter the folder name and press Enter. The new folder displays in the tree and the Label eld on the editor
populates with the name of the new folder.

Tip:  You can click Save or you can save the new folder and close the editor simultaneously by clicking
Save and Close.
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4. To add a subfolder, right-click a folder and select New Folder.

Folders and Items in the Tree  
In addition to adding folders to certain conguration items to beer organize and group your data, you can also
rearrange folders and items in the tree using drag-and-drop operations.

When you move a folder, all items in the folder also move. You can also drag a folder onto another folder to create an
additional level in the hierarchy and reorder within a folder or move items to another folder.

Tip:  Remember that you can also add subfolders by right-clicking a folder and selecting New Folder.

Geing Started for Users  

Download Oracle Service Cloud and Log In  
No maer which channel you use to interact with customers, you need to quickly and accurately respond to them.

With Oracle Service Cloud, you have a variety of powerful tools to help ensure that every customer interaction is a
positive experience.

1. Open your web browser and navigate to hp://your_site.custhelp.com/cgi-bin/your_interface.cfg/php/
admin/launch.php.

2. Click Install Oracle Service Cloud.
A security message warns you that the application should not be installed unless you know that it is from a
trusted source.

Note:  If Oracle Service Cloud has been congured to use an external identity provider (IdP) for agent
authentication, an additional buon (Install Oracle Service Cloud–Internal Login) displays on the
Launch page. Clicking this buon opens the Oracle Service Cloud Login window without embedding
the IdP’s login page. This lets accounts that do not have the SSO Login (SAML 2.0) prole permission
log in without using the external IdP. See Single Sign-on Support in Oracle Service Cloud.

3. Click Install.

After Oracle Service Cloud downloads to your workstation, the Login window opens. (This can take a few
minutes.)
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The Login window may look dierent from the one shown here if your administrator has customized it.
a. To view all deployment les and processes, click View Log File.

4. If you need help logging in, for example, if you’ve forgoen your password, click Login Help.
5. Enter your user name in the Username eld.

Your user name and password are dened in your sta account and both are case sensitive.

◦ If you aempt to log in to this application using the same user name and interface name as another sta
member who is already logged in on a dierent workstation, and the cache les are stored in the same
location for the two instances, you will receive a message that the application is already running and
the subsequent session will not be started. However, if you are using the same user name and interface
as another sta member, but the cache les are not stored in a shared location (in a non-virtualized
environment), the cache les will not be overwrien and the second session will start, overriding and
ending the rst session.

◦ If you aempt to log in to the same site you are already logged in to on the same workstation using the
same user name and interface, or another sta member is already logged in on that workstation with the
same user name and interface, the initial instance will be brought to focus and no message appears.

◦ Although user names and passwords are case sensitive, two sta accounts with user names that are
identical except for case cannot be logged in on the same workstation at the same time. If you aempt
to do so, the Login window closes and the console for the rst sta member logged in will be brought to
focus and no message appears.

6. If you have been assigned a password, enter it in the Password eld. (Passwords are optional in Oracle Service
Cloud.)
The Interface eld displays the name of the interface you entered in step 1. The drop-down menu contains the
names of any additional interfaces installed for this site, beginning with the rst interface installed.

7. Click Login.
The Service Console opens after the system updates and loads all necessary support les.
The application icon now appears in your system tray. Hover over the icon to view your site name.

What displays when you initially log in depends on how your application is congured and what permissions
have been assigned in your prole.

After downloading Oracle Service Cloud and logging in the rst time, access your application from Start/All Programs/
RightNow/your site name .

Related Topics
• How You Add Your Branding on the Login Window

• Login Help Options

• Session Expiration
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Session Expiration  
This topic describes how long the console remains active after logging in and how to prevent lost work after your
session expires.

Oracle Service Cloud is set up to automatically log you out after a specic period of inactivity on the console (by default,
fteen minutes). After your session expires, you will receive a Console Locked message, and you must re-enter your
password to resume work without any loss of data.

If you choose to exit the application, all your unsaved work will be lost. In addition, after entering four incorrect
passwords, you will be locked out of the console and must re-launch the application. Any unsaved work will be lost.

Note:  If you log in through an identity provider (that is, using the single sign-on process), you will not have the
opportunity to re-enter your password to continue working in the application. Any unsaved work will be lost.

Related Topics
• Automatically Logging Out Inactive Sessions

• Single Sign-on Support in Oracle Service Cloud

Overview of the Service Console  
The Service Console (also called the agent desktop) is where you will work with Oracle Service Cloud.

Whether you respond to incidents to answer customer questions, create and send mailings to contacts, or work
opportunities and send quotes to customers, you can access everything you need from the Service Console. And while
the interface is easy to navigate, we recommend that you take the time to learn about the key areas on the Service
Console and how to perform some basic tasks.

Related Topics
• File Menu

• Console Ribbon

• Navigation Pane

File Menu  
Many of the options you will need to access when working in your application are accessed from the File menu.

Click File on the ribbon to access a menu of options for working in your application. The le menu is divided into two
panels. The left panel contains content-dependent options at the top, meaning that the options you see depend on
what is currently displayed on the content pane (for example, a Print option appears when a report is open). Below
this section are global options, meaning they are constant and will always appear on the le menu no maer what is
displayed on the content pane (Community, Links, Help, Add-In Logging, Options, and Exit). The panel on the right side
of the menu contains shortcuts for adding records and items to the knowledge base.
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Section and Option Description

Content-dependent Options The top section on the left panel contains options for performing actions on what is displayed on the
content pane. These options will change to reect the active tab on the content pane.
You can add content-dependent options to the Quick Access toolbar. See Customize the Quick Access
Toolbar.
 

Global Options This section on the left panel contains options for accessing other areas in the application. Global
options display no maer what is displayed on the content pane.
You can also add global options to the Quick Access toolbar.
 

Community Select Community to access the following options.

Discussion Forum Select this option to participate in discussion forums with other customers.

Idea Lab Select this option to access a feedback forum where you and other customers can submit ideas,
 collaborate on development, vote for your favorite ideas, and see which ideas are being implemented.

Support Knowledge Base Select this option to search for answers on our support site, submit questions, and access your account
information.

Documentation Select this option to access documentation for all Oracle Service Cloud products.

Tutorials Select this option to take any of our tutorials, which walk you through product functionality and
features based on user personas (administrators, users, and sales representatives). You can choose
tutorials for any supported release of Oracle Service Cloud.

Best Practices Select this option to explore our best practice guides to improve the customer experience you deliver.

Training Select this option to access the Oracle University website for information about training classes and
available delivery channels.

Developer Resources Select this option to access our developer community to help you congure, manage, and extend
Oracle Service Cloud beyond the enterprise.

Links Select Links and choose from the following options.

Oracle Service Cloud Interfaces Select this option to access any of the interfaces dened for your application and their associated
Service Console and customer portal. (The link for the customer portal is called End-user.)

Oce Integration Choose from the following options.
• Install Outlook Integration—Select this option to install Outlook Email Sync, Outlook Contact

Sync, and Outlook Task Sync.

• Install Incident Reference Number Smart Tag—Select this option to install the Oracle Service
Cloud SmartTag so you’ll be able to open incidents on the agent desktop from email messages in
Microsoft Outlook.

Outlook integration must be enabled for these options to be available.
 

Oracle Service Cloud Customer Portal The Site Administration option lets you access the Customer Portal Administration site.
The development area must be enabled in order for this option to appear (MOD_CP_DEVELOPMENT_
ENABLED in Common/Oracle Products/Modules).
 

• Site Administration Select this option to set a cookie for viewing the development pages or one of the other available page
sets (production, staging, and reference implementation). From this option you can also create custom
widgets and view documentation about all widgets.
Other functions include page set mapping, dening data elds, identifying framework and widget
versions, viewing logs, and staging and deploying your customer portal.
 
You must also have customer portal permissions in your prole for this option to appear.

22



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Section and Option Description

 

• External Links Select this option to access any custom links dened for your application. Custom links can include
commonly used URLs or any website you may need to access.

Help Select Help to access the help contents, help index, help search, documentation and tutorials for all
Oracle Service Cloud products, and product version information.
Context-sensitive help is available throughout the application when working with reports, records,
editors, and explorers. (The context-sensitive Help buon is located on the far right of the ribbon.)
 

Add-in Logging Select Add-in Logging to view the current or previous log le. See View Add-In Log Messages.

Options Select Options to change your sta account seings, local seings, and password. You can also
customize the content pane and navigation pane display, set tool windows visibility, and return tool
windows to their default locations. See Application Options.

Exit Select Exit to log out of the application.

Create new items On the right panel is a list of all the records and items you can add to the knowledge base. The order of
records and items in your list is selected by your administrator in your navigation set and the products
and components that are enabled.
The options in this list are added to your navigation set for the le menu. If a record or item hasn’t been
added, then it won’t appear in the list even if you have permission in your prole to create the record or
item. Likewise, if your navigation set contains options to create records and items from the le menu,
but you haven’t been assigned permissions in your prole, then those options will not appear in the list.
 

Dashboard (Ctrl+Shift+B) Select this option to create a dashboard. See Overview of Dashboards.

Report (Ctrl+Shift+R) Select this option to create a custom report. See Overview of Custom Reports.

Image Select this option to create a report image. See Images Explorer.

Style Select this option to create a report style. See Styles Explorer.

Chart Style Select this option to create a chart style. See Chart Styles Explorer.

Color Scheme Select this option to create a color scheme. See Create a Color Scheme.

Text Field Select this option to create a text eld to add to a custom report or dashboard. See Create a Text Field.

Contact (Ctrl+Shift+C) Select this option to add a contact. See Add a Contact.

Organization (Ctrl+Shift+O) Select this option to add an organization. See Add an Organization.

Task (Ctrl+Shift+T) Select this option to add a task. See Add a Task.

Answer (Ctrl+Shift+A) Select this option to add an answer. See Overview of Answers.

Incident (Ctrl+Shift+I) Select this option to add an incident. See Add an Incident.

Asset (Ctrl+Shift+N) Select this option to add an asset. See Add or Edit a Sales Product to Use with Assets.

Opportunity (Ctrl+Shift+P) Select this option to add an opportunity. See Overview of Opportunities.

Campaign (Ctrl+Shift+G) Select this option to create a campaign. See Overview of Campaigns.

Surveys Select this option to create a survey or survey question. See Overview of Surveys and Overview of
Questions.

Mailing (Ctrl+Shift+M) Select this option to create a mailing. See Overview of Mailings.
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Section and Option Description

Audience Select this option to create a contact list or segment. See Add a Contact List and Create a Segment.

Content Library Select this option to create a document, template, snippet, tracked link, or le. See Overview of Content
Library.

Guided Assistance Guide (Ctrl+Shift+E) Select this option to create a guide to assist sta members and customers in locating answers. See
Overview of Guided Assistance and Find Answers Using Guided Assistance. Guided assistance must
be enabled for this option to appear in the list and you must have permission in your prole to create
guides.

Related Topics
• How You Customize the Links Menu

• How You Congure Outlook Integration

Console Ribbon  
The console ribbon displays tabs and buons associated with the report, editor, or explorer you are working with.

Next to the le menu is the ribbon, which displays on all reports, records, and explorers. The ribbon consists of tabs and
buons for performing actions on an entire report, individual records in a report, or items in an explorer tree or list. See
Common Functionality Ribbon.

Tip:  If nothing opens on the content pane when you log in, the ribbon will be empty. See Change Your
Navigation Pane Seings to dene what opens on the content pane when you log in.

Navigation Pane  
On the left side of the console is a navigation pane containing Recent Items and Navigation tool windows.

There’s also a navigation pane on the right containing the Quick Search tool window, which you can use to search for
any record or item in the knowledge base. Although this setup is part of the default conguration, the tool windows can
be put in any order or displayed in separate, oating windows. Tool windows can also be removed from the console. See
How You Move Tool Windows.

This image shows the default conguration for the left navigation pane. The Answers navigation list is the active list in
this example, displayed by clicking Answers on the navigation pane.
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Legend for image: 1. Minimize 2. Customize List 3. Close 4. Navigation set buons

The majority of your work will begin on the left navigation pane where you can select the reports, records, and other
items you need. At the top is Recent Items, which lists the records and items you have recently opened. Next is the
Navigation tool window, which contains all of the navigation buons in your navigation set.

Each record type (answers, assets, contacts, incidents, opportunities, organizations, and tasks) and component (such
as analytics, campaigns, mailings, and surveys) has a corresponding navigation buon. Your administrator has created
a navigation set containing the navigation buons you can access and assigned it to your prole. This determines the
buons and associated navigation lists that appear on the navigation pane. (Conguration may also be part of your
navigation set if your administrator added it.)

Note:  By default, the navigation list that appears when you log in will be the navigation list that was active
when you logged out.

Navigation lists are organized in a tree and can contain any of the following items.

• Folders—Folders are used to organize reports, dashboards, and other items in a navigation list.

• Reports—Reports include records reports (answers, assets, contacts, incidents, opportunities, organizations, or
tasks), standard reports, and custom reports.

• Dashboards—Dashboards are any combination of individual reports shown together in one report on the
content pane.

• Explorers—Explorers display information on the content pane in hierarchical folders and are available for
certain components and conguration items. Explorers can be added to any navigation list. See Associate
Products and Categories to an Answer.

• Miscellaneous items—Notications, archived incidents, and the social monitor component are just a few of the
other items that can be placed in a navigation list.

Related Topics
• How You Customize Navigation and Conguration Lists

• Change Your Navigation Pane Seings
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Tool Window Buons  
Tool window buons let you customize the display of windows.

The buons next to each tool window title let you customize a single window or all windows. For instance, the top tool
window on each navigation pane (both left and right in the default console conguration) contains a Minimize buon,
which collapses the navigation pane so all tool windows on that navigation pane run down the side of the console.

In this example, only the left navigation pane is collapsed. The right navigation pane, containing Quick Search, is
maximized. To maximize the left navigation pane, click the right arrow at the top.

You can also close individual tool windows by clicking X (Close) next to a window title and customize the items in
any navigation list and the Quick Search menu by clicking the Gear (Customize List) icon. See How You Customize
Navigation and Conguration Lists.

How You Move Tool Windows  
Being able to move tool windows gives you the exibility to arrange your console to suit your own work preferences.

You might want all windows to remain on the navigation pane but want them in a dierent order. Or you might want
to move all tool windows to the left or right navigation pane or to the status bar to create more space on the content
pane. Plus, you can return the windows to their default locations at anytime. Click File and select  Options > Reset Tool
Windows  or see Change Your Personal Seings and select the Reset Local Seings check box.

In the default console conguration, Recent Items and Navigation display on the left navigation pane and Quick Search
displays on the right.

When you drag a window to another area on the console, the content pane momentarily changes to light gray, the area
where you can dock the window is highlighted in blue, and a docking area indicator displays. In this example, we’re
moving the Quick Search tool window to the left navigation pane.
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When you release your mouse, Quick Search is docked on the left navigation pane.

Using the same technique, you can move all tool windows to the status bar.
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When a tool window is docked to the status bar, just click its buon to display a full yout. For the Quick Search tool
window, the rst docked lter displays on the buon. Simply enter an entry and click Search. If you want to change to
another Quick Search report, click the arrow next to Search to display the full Quick Search menu.

Tip:  To move a tool window from the status bar, move your pointer to the doed divider line to the left of the
tool window you want to move and drag it to its new location.

Available Actions from a Navigation or Conguration List  
The actions available from a navigation or conguration list vary depending on the item you have selected and your
prole permissions.

When you display the list you want, just double-click a report or other item to open it on the content pane. You can also
right-click any item to select other actions. Be aware that certain actions require one or more prole permissions.

Right-Click Available Actions

Report or Other Item Select from the following actions.

Open Select this action to open the report or item on the content pane.
This is the only right-click option available for conguration items.
 

Open in New Tab Select this action to open a second copy of a currently open report in a new tab on the content pane.
This action is available only when you right-click a report that is already open.
 

Queue Select this action to manually schedule the report to run in the background.

View Report Denition Select this action to view the report denition in a new window.

Edit Report Denition Select this action to edit the report. If you select this action for a standard report, the report does not
open. Instead, the content pane displays options for creating a schedule to generate and distribute the
report and for changing prole permissions for the report if your prole lets you assign permissions.
Also, a message displays at the top of the content pane telling you that this is a read-only report.
This action will not display if you do not have appropriate Analytics permissions in your prole.
 

The remaining right-click actions appear only if you have the Customize Navigation Sets permission in your prole.

Remove from List Select this action to remove the report or item from your navigation or conguration list. You will be
prompted to conrm the removal.

Set as Default Select this action to set the report or item as the default for this list. Default items have Default
appended to their name. When you right-click a default item, this option changes to Unset as Default.
The item you set as the default will automatically open on the content pane when the item’s navigation
or conguration list displays when you log in. For information about the other options available when
you log in, see Change Your Navigation Pane Seings.
 

Folder Select from the following actions.
Folder options do not apply to the conguration list. However, folders can be renamed and removed
from a conguration list on the Navigation Sets editor.
 

Rename Select this action to rename a folder in a navigation list.

Remove from List Select this action to remove a folder and all of its contents from the navigation list.
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How You Customize Navigation and Conguration Lists  
You can customize what displays in your navigation and conguration lists to help you work more eciently.

If your prole lets you customize your navigation set, a Gear icon (Customize List) displays at the top of the Navigation
tool window. You can add any report or dashboard you have permission to run, search for items to add, search for a
report or item to add, add multiple items at the same time, remove items, and rearrange items in your list. You can add
items only from the Available Items list, not folders. (Folders do not apply to Quick Search reports.)

Related Topics
• Add Items to or Remove Items from a Navigation or Conguration List

• Search for an Item to Add to Your Navigation List

• Organize Items in a Navigation List

Add Items to or Remove Items from a Navigation or Conguration List  
This procedure customizes only your navigation list, not the navigation set assigned in your prole.

1. Display the list you want to change.
2. Click the Gear icon.

The Customize List window opens. The tree under Available Items on the left lists all the folders for the reports
and components you have permission to access. The tree under Selected Items on the right displays the
contents of your list.

3. To add an item, expand the appropriate folder under Available Items.
a. Select the item and click Add.

You can also double-click the item or drag the item to your list and drop it where you want it to display.
b. To add multiple items at the same time, press Ctrl while making your selections and click Add.

Tip:  To set an item as the default for the list, right-click the item under Selected Items and
select Set as Default. The item will automatically open on the content pane when that item’s list
displays when you log in.

4. To remove an item, select it and click Remove.
Other ways to remove items include right-clicking an item and selecting Remove from List or selecting an item
and pressing Delete.

5. Click OK.
Your changes are saved and the window closes.

Related Topics
• Search for an Item to Add to Your Navigation List

• Organize Items in a Navigation List

Search for an Item to Add to Your Navigation List  
You can search for items you want to add to your navigation list.

1. Click Find in List next to Available Items.
The Find window opens.

2. Enter your search term in the Find What eld.
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3. Click Find Next.
4. To match case or whole word, select the appropriate check box.
5. To specify the direction of the search in Available Items, select Up or Down.

As you enter leers, the system highlights the rst item in the list that begins with the leers you enter. If this
is the item you want, close the window. Otherwise, continue entering or click Find Next to scan for the next
occurrence. If no match is found, a message displays on the boom of the window.

6. If your search returns a match and you want to add it to your list, close the window and click Add.
7. Click OK.

Your changes are saved and the window closes.

Related Topics
• Add Items to or Remove Items from a Navigation or Conguration List

• Organize Items in a Navigation List

Organize Items in a Navigation List  
You can organize items in your navigation list to more easily access the items you use most.

1. To reorder items in the list, select an item and click Move Up or Move Down. This action moves the item up or
down one position. You can also drag an item to where you want it in the list.

Tip:  The Move Up and Move Down buons are context-sensitive. For instance, if you select the rst
item in your list, the Move Up buon is disabled. Likewise, if you select the last item in your list, the
Move Down buon is disabled.

2. To add a folder to your list, click New Folder and name the folder.

If no item in your list is selected, the new folder is placed at the end of the list. If an item is selected, the new
folder is placed immediately after the selected item. And if a folder is selected, the new folder is placed beneath
the parent folder. This buon is disabled when you have multiple items selected in your list.

3. To rename a folder, select a folder, click Rename, and enter the new name.
4. Click OK.

Your changes are saved and the window closes.

Related Topics
• Proles

• How Custom Navigation Sets Work with Proles

• Add Quick Search Reports to a Navigation Set

How You Reorder Items  
Using drag-and-drop functionality, you can reorder the items in your navigation and conguration lists.

You can also move a folder and its contents or move an item from one folder to another. You can reorder items from the
navigation pane or from the Customize List window, described in How You Customize Navigation and Conguration
Lists. Keep in mind, however, that you must have the Customize Navigation Sets permission in your prole to change
the order of items in your lists.
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Related Topics
• Analytics Permissions

• Create a Navigation Set for the Administrator

• Create a Navigation Set

Available Actions from the Recent Items List  
The records and items you’ve recently opened are listed in the Recent Items tool window.

Records and items are grouped into four categories, including Pinned, Today, Yesterday, and Older. Only the categories
that have recent items display (for example, if only one record or item was opened today, the Today category will be
the only one listed in the recent items list). By default, the last ten items you opened are listed, but you can increase or
decrease that number if you want. See Change Your Navigation Pane Seings.

Tip:  Conguration items are not tracked in the recent items list.

You can double-click an item to open it or right-click an item to display additional actions. Unlike navigation lists, which
require a prole permission for certain actions, all sta members can perform the actions from the recent items list.

Right-Click Available Actions

Open Select this action to open the item on the content pane.

Copy Tooltip to Clipboard Select this action to copy the item’s tooltip to the clipboard. You can then insert the tooltip in another
record or item. Tooltips vary according to the item or record type. For instance, an incident tooltip
contains the reference number, subject, contact name, contact ID, contact email address, contact
phone number, and organization name; the tooltip for an answer contains the answer summary,
 answer ID, language, and answer access levels; and the tooltip for a mailing contains the mailing name.

Copy Text to Clipboard Select this action to copy the item’s name or summary information to the clipboard. You can then insert
the text in another record or item. For instance, copying text to the clipboard for an answer copies
the text in the Summary eld. Copying text to the clipboard for an incident copies the number in the
Reference # eld. And copying text to the clipboard for a mailing copies the mailing name.

Remove from List Select this action to remove the item from the recent items list.

Recent items also appear in other areas of the product to help you quickly select commonly used items when updating
record elds. See How You Search from Open Records and Assign a Record from a Report.

How You Search Recent Items  
This topic describes how to use search to quickly locate a record in your recent items.

You can search for recent records and items using a text search and lter by type (for example, incident record type).
Click the Search eld drop-down menu to view all record types available to search in your recent items.
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Note:  Only record and item types recently opened will appear in the drop-down menu. For example, if you
recently opened a contact record and an incident but not an organization, only Contact and Incident will
appear in the drop-down menu.

How You Pin Recent Items  
By default, the last ten records and items you opened appear in your recent items list, but you can increase or decrease
that number whenever you want.

There might be times when you have an item that you don’t want to scroll o the recent items list, no maer how many
items you’ve set to appear in your list. For those instances, you can pin one or more items to ensure they remain in your
recent items list for as long as you need.

Click the Pin icon that appears when you hover over an item. Pinned items appear at the top of the Recent Items tool
window.

When you no longer want an item pinned, just hover over it and click the Unpin icon.

Related Topics
• How You Search from Open Records

• Change Your Navigation Pane Seings

• Assign a Record from a Report

How Buons in Your Navigation Set Display  
By default, one row of buons displays at the end of the Navigation tool window no maer which navigation list is
active.

Clicking Congure Buons, indicated by the right arrow next to the row of buons, displays the remaining buons in
your navigation set and options to show more or fewer buons.

• Show More Buons—Select this option to add a navigation buon in a large format. As you add a buon, its
smaller version is removed from the boom of the navigation pane. This action adds large buons one at a
time.

• Show Fewer Buons—Select this option to show fewer navigation buons in the large format. Selecting this
option removes the buons one at a time. As each large buon is removed, its smaller version is added to the
boom of the navigation pane.
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You can also change the number of buons that display by pointing to the slider bar and dragging the bar up or down
when the pointer becomes a double-headed arrow.

To change the order of the buons on the Navigation tool window, see Change Your Navigation Pane Seings.

Overview of the Content Pane  
The content pane is the area of the console that displays the report or other item you select from a navigation list, from
your list of recent items, or from the le menu.

The content pane also displays results from a search. The exact placement of the content pane depends on whether you
have one or two navigation panes on the Service Console. In the default conguration, the content pane displays in the
middle of the console.

You may work with any of the following items on the content pane.

• Reports—Access a custom report to edit the report denition or a standard or custom report to generate the
report.

• Dashboards—Access a dashboard, which is any combination of reports that display together in one report.

• Records—Access a report containing a list of records and select one or more to open. See Open an Incident for
Editing. You can also open an individual record from the Recent Items tool window. See Available Actions from
the Recent Items List.

• Explorers—Access any of several components and conguration items that display information in hierarchical
folders. See Associate Products and Categories to an Answer.

• Notications—Access your messages when there is a change in the status of your incidents and answers in
Oracle RightNow Cloud Service (Service), mailings and campaigns in Oracle RightNow Outreach Cloud Service
(Outreach), or opportunities. You will also receive a notication when you are assigned a new incident, answer,
or opportunity. See Notications.

• Search results—Access items and records from a standard search or a Quick Search. See Record Search Options.
(The Quick Search menu is a default tool window that displays on the navigation pane. See Navigation Pane for
details about tool windows.)

To change the way information displays on the content pane, including the content pane tabs, see Application Options.

Content Pane Tabs  
Tabs on the top of the content pane display all the items you currently have open.

When more than one item is open, just click a tab to return to that item or right-click a tab and select from the following
options: Open in New Window, Close, Close All But This, and Close All. You can also press Ctrl+W or Ctrl+F4 to close the
active tab or click Close (X) on any content pane tab. See Close Multiple Records Simultaneously.

Right-click options dier for records in a workgroup. When you right-click the content pane tab of the primary record,
your only option is to close all associated records in the workgroup. When you right-click an associated record that is the
active tab, your options include Accept Changes, Cancel Changes, and Undock. See Record Workgroups.
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Tip:  On certain workspaces editors, including incidents, contacts, organizations, and tasks, you can undock
an open record by clicking Undock on the active tab or Undock on the ribbon. This action opens the record in
a separate window and lets you move between the window and console without having to close the window
rst.

Related Topics
• Overview of Managing Reports on the Reports Explorer

• Overview of Dashboards

Application Options  
After you become familiar with the agent desktop, you may want to customize certain areas based on your personal
preferences and what works best for you.

You can change seings specic to your sta account that will be reected when you add certain records to the
knowledge base, change your password, and customize how the navigation pane, content pane, and tool windows
display. Click File and select Options on the left. The application options display on the right.

Option Description

Personal Seings Select this option to change seings in your sta account and certain local seings. See Change Your
Personal Seings.

View Options Select this option to change how information displays on the content pane, including content pane
tabs; change the color and tint of the interface; and display the date, server time, and time zone in the
status bar. See Change Your View Options.

Navigation Pane Select this option to change the order of the buons on the navigation pane, change the number of
items that display in the recent items list, and choose what displays on the content pane when you log
in. See Change Your Navigation Pane Seings.

Tool Windows Select this option to choose which tool windows (Recent Items, Navigation, and Quick Search) are
visible. See Change Tool Window Visibility.

Add-Ins Select this option to view the list of add-ins that are active (enabled) for your prole and the interface
you are logged in to. Inactive add-ins are also displayed in the list. See View Add-Ins Enabled for Your
Prole.

Communication Center Select this option to customize your chat notication seings. See Chat for Agents, Supervisors, and
Customers.
Oracle RightNow Chat Cloud Service (Chat) must be enabled for the Communication Center option to
be available.
 

Reset Tool Windows Select this option to return the tool windows to their default locations.
You can also return tool windows to their default locations by selecting the Reset Local Seings check
box in your personal seings. See Change Your Personal Seings.
 

Change Your Personal Seings  
This topic describes how to change your sta account seings using the Personal Seings option.
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Some personal seings apply to options in your sta account and some seings apply to local seings, the interface
defaults in Oracle Service Cloud. Any sta account changes you make from the Personal Seings option will also be
made to the corresponding seings in your sta account.

1. Click File and select  Options > Personal Seings .
2. Select from the options listed.

Field/Buon Description

Notication Options This section contains options for changing how you receive notications.
Changes you make here will also be made to the corresponding seings in your sta
account.
 

Send Email Notication Select this check box if you want an email sent to your default email client (your external
email application) when you receive a notication while you are not logged in to Oracle
Service Cloud. An email will be sent to your email client the rst time a notication is
delivered while you are logged out. Subsequent notications won’t generate an email
until you log in and out of the system.
This check box is disabled if you don’t have an email address specied in your sta
account. In addition, you must select this check box in order to select the Send Detailed
Email Notication and Notify Always check boxes that follow.
 

Send Detailed Email Notication Select this check box if you want an email containing detailed information sent to your
default email client (your external email application) when you receive a notication
while you are not logged in to Oracle Service Cloud. An email will be sent to your email
client the rst time a notication is delivered while you are logged out. Subsequent
notications won’t generate an email until you log in and out of the application.

Notify Always Select this check box if you want to receive an email for every event that triggers a
notication even if you are logged in to Oracle Service Cloud.

Display Toast Notications Clear this check box if you don’t want to receive notications in a desktop alert, often
referred to as “toast notications.” By default, when you log in to Oracle Service Cloud,
 you receive a desktop alert listing new notications. The message displays for several
seconds in a window on the lower right of the screen. See Notications.
This is a local seing and an interface default seing.
 

Localizations Options in this section let you change seings that apply when you add certain records
such as opportunities.
Changes you make here will also be made to the corresponding seings in your sta
account.
 

Default Country Click this drop-down menu to change the default country in your sta account. United
States is the default.

Default Currency Click this drop-down menu to change the default currency in your sta account. U.S.
Dollar is the default.

Time Zone Click this drop-down menu to select the time zone in which you are working.
This seing does not apply to all sta members and therefore may not appear.
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Field/Buon Description

 

Email The option in this section lets you edit your email signature.

Email Signature If you have an email address specied in your sta account and the permission to
customize your signature, make your changes in this text box.

Application Behavior Options in this section let you select application behavior seings.

Automatically Sign Out when Last
Console is Closed

Select this check box to prevent the Exit message from displaying when you close the
last console or select Exit on the le menu.
This is a global seing stored on your workstation and applies to all the interfaces on
this site that you can access.
 

Always Correctly Refresh Editors
when Application is Resized

Clear this check box to ensure that editors load faster on the console. This option
displays only when Oracle Service Cloud is installed on 64-bit operating systems.

Note:  This option is designed to compensate for a Windows limitation when
resizing one or more windows on 64-bit operating systems. However, when
this option is enabled, which it is by default, you may experience more screen
ickering and editors may load more slowly. Also, be aware that when you
clear this option, editors that have been resized may not refresh properly.

Disable Rich Client Visual
Experience

Select this check box to use software rendering instead of hardware rendering on the
console display.
This option is eective if you have limited hardware, such as a slow graphics card, which
might cause repainting or display issues. However, if you have adequate hardware,
 selecting this check box may slow down operations.
 

Local Data This section contains options for reseing your local seings and refreshing your local
cache.

Reset Local Seings Select this check box to reset local seings to the interface defaults.

Rebuild Local Data Cache Select this check box to remove your local cache entries and request current copies from
the server.

Authentication The option in this section lets you change the password for logging in to your
application.

Change Password Click this buon to change your password. See Change Your Password.

3. Click OK.

Related Topics
• Add or Edit a Sta Account

• Rebuild Your Local Cache
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Rebuild Your Local Cache  
You can remove your local cache entries while logged in and request current copies from the server without manually
deleting the les.

Your local cache les store all option lists data (any data accessed from a drop-down menu or menu list, such as
customizable menu items) plus additional data such as report and workspace denitions, questions, documents, and
standard text. If you aren’t sure whether your local copy of common data matches the data on the server, rebuild your
local cache to retrieve the most up-to-date data.

Note:  Contact your administrator or supervisor before rebuilding your local cache.

1. Click File and select  Options > Personal Seings .
2. Select the Rebuild Local Data Cache check box under Local Data.
3. Click OK.

A prompt asks you to conrm your request.
4. Click Yes.

A progress bar displays on the content pane. After all data is received from the server and wrien to the cache,
the progress bar and window close.

Change Your Password  
Your organization may have security policies that require strong passwords for sta to use to log in.

If this is the case, your sta account contains a password you must use each time you log in. You may also need to
change your password at regular intervals.
If your prole contains the SSO Login (SAML 2.0) permission for single sign-on, you cannot change your password in
Oracle Service Cloud. See Agent Login Using an IdP-initiated SSO.

1. Click File and select  Options > Personal Seings .
Your personal seings display.

2. Click Change Password.
3. Enter your current password and press Tab. Don’t forget that your password is case sensitive.
4. Enter the new password and press Tab.

If an entry does not meet your organization’s password requirements, such as password length or character
repetition, the system highlights the incorrect entry.

5. Re-enter your new password.
6. Click OK.

The Oracle server veries your password history (both current and new passwords) and, if errors are found,
displays the requirements that were not met.

Change Your View Options  
As you become familiar with your application and navigating the console, you may want to change the way information
displays on the content pane.

By default, when you open an item, it appears in full window display. You can change the default content pane display to
a split window or pop the content pane in a new window. You can also change the placement of the content pane tabs,
change how information displays in records, change the interface color, and display date, time, and time zone in the
status bar.

Tip:  All view options are local seings.
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1. Click File and select  Options > View Options .
2. Select from the view options listed.

Field Description

Appearance The options in this section apply to the interface color.

Color Scheme Click this drop-down menu to change the interface color scheme.

Tint Click this color box to select a tint for the interface color. You can also dene a custom
color.

Content Pane View Mode This section contains options for changing how information displays on the content
pane.

Full Screen Leave the default, Full Screen, if you want the report or item to appear in full window
display.

Split Window Select this option to display your items in a split window. In split window, explorers
always open on the top half of the window and all other items open on the boom. Drag
the divider in the middle of the content pane up or down to show more of one record or
item.

Display Content Editors in Popup
Windows

Select this option to pop the content pane in a new window. For instance, if you add a
record or open one to edit, the record opens in a separate window. Selecting this option
applies to the next editor you open, not any that are currently open.
Selecting this option places the window on top of the console, which prevents the
window from disappearing behind other applications, but you must close the window
before returning to work on the console. As an alternative to this option, you can undock
administration and workspaces editors from the console and work between the console
and a separate window without having to close the window rst. See Content Pane Tabs
and Record Workgroups.
 

Content Editors This section contains a seing for changing how records display on the content pane.

Display Content Editors in Expanded
Mode

Select this check box so you can scroll through all of a record’s elds rather than clicking
tabs to access specic eld information.

Content Pane Tab Alignment This section contains options for choosing where the content pane tabs appear.

Top By default, content pane tabs display at the top of the content pane.

Boom Select this option to display content pane tabs on the boom of the content pane.

Status Bar This section contains options for displaying the server time and time zone in the status
bar.

Show Server Time in the Status Bar Select this check box to display the date and server time in the status bar of the console.
Selecting this check box enables the Display Time Zone check box so you can select that
option as well.
 

Display Time Zone Select this check box to display the time zone next to the server time in the status bar.
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Field Description

Show Recent Items in Fields By default, recent items display in workspace menus and search elds. For example, if a
contact record is opened from an incident, the contact displays under Recent when you
click in the Contact search eld of the incident record. Clearing this check box prevents
recent items from displaying in workspace menus and search elds.

3. Click OK.

Change Your Navigation Pane Seings  
Navigation pane seings determine the order of the navigation buons and the Conguration buon on the navigation
pane, which buons display, and what opens on the content pane when you log in.

You can customize these and other seings to suit your specic work responsibilities and preferences.

Note:  Navigation pane seings are local seings. Consequently, any customizations you make from this
option, except for reseing your navigation set, will be removed if you select the Reset Local Seings check
box from the Personal Seings option. See Change Your Personal Seings.

1. Click File and select  Options > Navigation Pane .
2. Select from the navigation pane options listed.

Field/Buon Description

Navigation Set Order and Visibility This section contains a list of all the navigation buons in your navigation set and the
order in which they display on the navigation pane. All buons are selected by default.
Depending on your prole permissions, you may also have the Conguration buon in
your navigation set and it will display in this list as well.
 

Buons List Clear the check box next to any buon that you do not want to appear on the navigation
pane. Clearing a check box does not remove the buon from your navigation set. It just
prevents the buon from displaying, and you can display it again at any time.

Move Up After selecting a navigation buon, click this buon to move the navigation buon up
one position in the list.

Move down After selecting a navigation buon, click this buon to move the navigation buon
down one position in the list.

Reset Click this buon to reset the order of the buons that appear on the navigation pane to
the order dened in your navigation set.

Reset Navigation Set to Prole
Default

Select this check box to remove all customizations you have made to your navigation
lists and reset to your prole’s default navigation set. See How You Customize
Navigation and Conguration Lists.
This check box won’t appear unless you have the Customize Navigation Sets permission
set in your prole.
 

Recent Items This section contains an option for dening how many items you want in the recent
items list. Recent items are interface specic and include those records and items you
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Field/Buon Description

have recently opened. Keep in mind that the system does not track conguration items
in the list.
If you make a change to a eld on the Contacts or Organization tab of an incident, the
contact or organization record will not appear in this list. However, if you open the
contact from the incident or the organization from the contact record (by clicking the
contact or organization and selecting Open), the record will appear in your recent items
list.
 

Items Shown in Recent Items List Enter a number or click the arrows to change the number of items to show in this list.
The default is 10 items and the maximum is 40.

Note:  If you are working on the Agent Browser UI, the maximum number of
items to show in the list is 20.

Recent items associated with disabled products will not appear in the list. For instance, if
you edit an opportunity and then Opportunity Tracking is disabled, the opportunity will
no longer appear in your list.
 

Behavior This section contains options for choosing how to open items on the content pane and
what, if anything, opens when you log in.

Double Click to Open Items Clear this check box to open items with a single click. By default, you must double-click
a report or any item in your navigation list to open it on the content pane.
This seing also aects the way you open conguration items.
 

At Startup Open: The options in this section determine what displays on the content pane when you log
in.
By default, the navigation list or conguration list that appears when you log in will be
the same list that was displayed when you logged out.
 

Nothing Select this option if you want the last selected item in the navigation list to be selected
but not opened.

Default Navigation Item for Current
Page

Clear this option if you don’t want the default item for the navigation list to
automatically open on the content pane.
This option is selected by default. When the navigation list or conguration list does not
have a default item, nothing will open.
 

Last Navigation Item Opened in
Previous Session

Select this option if you want the last item that was open when you logged out to
automatically open when you log in, even if it is not in the list that displays when you log
in.

3. Click OK.
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Change Tool Window Visibility  
In addition to manually closing tool windows from the navigation pane, you can also change tool window visibility from
your application options.

1. Click File and select  Options > Tool Windows .
2. Clear the check box next to any tool window you want to hide. All tool windows are visible by default.
3. Click OK.

Tip:  You also have the option to add a custom tool window to the Service Console. Using the
NAVPANE_CUSTOM_WEB_CONTROL_URL conguration seing (RightNow User Interface/Tool Bar/
General), you can embed a web page on the navigation pane. After you add a fully qualied domain
name in the Value eld, a Custom Web Control tool window will display in the Tool Window Visibility
list. However, you must select the check box in the list in order to display your custom tool window on
the console. You can then move it just like any of the default tool windows.

Related Topics
• Available Actions from a Navigation or Conguration List

• Available Actions from the Recent Items List

• How You Move Tool Windows

Open the Reports Explorer  
Certain components and conguration items display data in hierarchical folders similar to Windows Explorer.

The main elements and basic functionality of explorers in Oracle Service Cloud are the same, but options may dier
slightly from one explorer to another. Explorers can be added to any navigation list or your conguration list, just like
any report or other item. For instance, the list of campaigns in your application display in an explorer, yet you can add
the Campaigns explorer to a navigation list other than the Campaigns navigation list.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer in the navigation list. The explorer opens on the content pane.

Tip:  Although the default requires that you double-click an item to open it, you can change the default
so that items open with a single click. See Change Your Navigation Pane Seings to select this option.

The following explorers are available in Oracle Service Cloud. Certain components contain multiple explorers.

◦ Analytics

◦ Campaigns

◦ Mailings

◦ Surveys

◦ Content Library

◦ Audiences

◦ Navigation Sets

◦ Workspaces/Workows

◦ Client Workow Images
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◦ Scripts

◦ Guided Assistance

Explorer Display States  
Explorers display in one of three states: Folders On, Folders O, and Search On. The display state determines what
information you see and what functionality is available. You change states using the Folders and Find buons on the
ribbon.

Folders On—In the default Folders On state, explorers display a folders tree on the left and a detailed list of the selected
folder’s contents (subfolders and items) on the right. The columns that display in the list are specic to each explorer.
For instance, the Reports explorer shows Created, Updated, Initial Run, and Refresh on Edit columns, while the Mailings
explorer might show Last Launched, Sent, and Clicked columns.

Folders O—When you turn o folders, the tree is hidden and the content pane displays only the detailed list of the
selected folder’s contents. However, the folder hierarchy is maintained. Depending on where you are in the hierarchy
when you turn o folders, you can double-click a folder to drill down or click Up to move up one level.

Click Folders to turn o folders. (You can also click X on the top right of the folders tree to turn o folders.) Click Folders
again to display the tree and turn folders on.

Search On—The third explorer display state is Search On. The left side of the content pane displays the Find menu. Click
Find to change to Search On. Click it again to turn o search. (You can also click X on the top right of the Find menu to
turn o search.)

Tip:  Turning o search puts the explorer in the Folders O state. To turn o search and display the folders list,
click Folders instead of closing the Find menu.

Search for a Report from the Reports Explorer  
The steps for searching are the same in all explorers. You can search any of the available columns in the list by selecting
a column from the Find Using drop-down menu.

Three data types are supported in explorer searches: strings (words), dates, and integers (numbers). The data type of
the column you select determines the available search criteria.

• String—The Name column is the default search column in all explorers. Because this is a string data type, you
can search for strings that start with, contain, end with, or match the value you enter in the search box. You can
also match the case by selecting the Case Sensitive check box.

• Date—If the column you select is a date data type, you can search for dates before, on, or after today’s date. You
can also click the calendar to display the current month’s calendar and select another day, or click the arrows at
the top of the calendar to change months.

• Integer—If the column you select is an integer data type, you can search for values that are less than, equal to,
or greater than a number. Either enter a number in the search box or select one using the arrows.

1. Double-click Reports Explorer in your navigation list.
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The explorer opens on the content pane.
2. Click Find.

The left side of the content pane displays a Find menu, hiding the folders tree.
3. Click the Find Using drop-down menu and select a column to search.
4. Select an option for your search criteria.
5. Enter your search text in the text box and click Find.

The search results display in the list on the right side of the content pane. You will receive a message when no
matches are found.

6. To remove the text entered from the previous search, click Clear.

Search Results Actions  
The actions you can perform after a search vary according to the search results and your prole permissions.

In addition to the common actions you can initiate from the ribbon or by right-clicking a le, you have an additional
option, Open Containing Folder, when you right-click a le returned in an explorer search. Select Open Containing
Folder to display the folder containing the selected le. This automatically closes the Find menu and returns the
explorer to the Folders On display state.

Right-clicking a folder returned in your search provides another option in addition to Open Containing Folder.

• Open Containing Folder—Select this option to display the parent folder in the tree.

• Open Folder—Select this option to display the folder in the tree.

Both actions close the Find menu and return the explorer to the Folders On display state.

Advanced Search Options  
You can use advanced search options to remove the results from your search, search your current results, or keep your
current results and add results from your next search. By default, conducting a new search removes the previous search
results.

Click Show Advanced Options on the boom of the Find menu. (You can click anywhere on the line to display the
advanced options.) The option then changes to Hide Advanced Options.

Option Description

Search globally, replace results Select this option to remove the results from the previous search and replace with results from this
search. This is the default option.

Search within results, replace results Select this option to search only the current results and keep only those that match this search.

Search globally, append to results Select this option to keep results from the previous search and add results from this search.

Tip:  You can also select the Return Non-Matching Items check box to return all les that do not match your
search criteria.
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Explorer Tree  
The primary way of moving around explorers is from the tree, although you can also select actions and change focus in
the explorer from the list, ribbon, and address bar.

Depending on the permissions in your prole and the explorer you are working in, certain actions may not be available.
For instance, if you select a standard report in the Reports explorer, the Delete action from the list and the buon on the
ribbon are not available since you can’t delete standard reports.

Option Action

Change the list Select a folder in the tree to change the list of subfolders and items that appear.

Expand or collapse all folders Right-click a folder to expand or collapse all folders in the tree. You can also click the plus or minus sign
next to a folder to expand or collapse a single folder.

Add a folder Right-click a folder and select New Folder. A new folder is created under the selected folder and you are
given the opportunity to name it.
This option is not available when you right-click a root or standard folder.
 

Delete a folder Right-click a folder and select Delete. When you select this action, you will be asked to conrm the
deletion.

CAUTION:  Deleting a folder deletes all of its contents as well. This action cannot be reversed.

This option is not available when you right-click a root or standard folder.
 

Rename a folder Right-click a folder and select Rename. The selected folder is put into an editable state.
This option is not available when you right-click a root or standard folder.
 

Reorganize folders Drag and drop a folder and its contents into another folder and move items from one folder to another.
Drag-and-drop may be restricted by permissions in your prole. Also, you cannot execute a drag-and-
drop that would result in a folder containing more than 12 levels.
 

Explorer List  
The actions available when working with the list depend on the explorer and the list of items.

Some actions can also be initiated from the ribbon. The actions available also depend on whether you right-click a
subfolder or an item.

Option Action

Open a subfolder Right-click a subfolder and select Open Folder. This action causes the parent folder to be selected in
the tree and its contents to display in the list. This option is available only when you right-click a folder.
You can also double-click a folder to open it.
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Option Action

Edit an item Right-click an item and select Edit. This action is available only when you right-click an item. You can
also double-click the item to open it for editing.
In the Reports explorer, double-clicking will run the report.
 

Open an item Right-click an item and select Open to view the item. This action is available only when you right-click
an item.

Queue a report Right-click a report and select Queue. This action manually schedules the report to run in the
background.
This option is available only on the Reports explorer.
 

Copy an item Right-click an item and select Copy. Select this action when you want to add an item that contains
many of the same aributes as the item you right-click. This option is not available when you right-
click a folder.

Delete a subfolder or item Right-click a subfolder or item and select Delete. You will be asked to conrm the deletion.

CAUTION:  Deleting a folder deletes all of its contents as well. This action cannot be reversed.

This option is not available when you right-click a standard folder.
 

Rename a subfolder or item Right-click a subfolder or item and select Rename. The folder or item is put into an editable state for
you to rename.
This option is not available when you right-click a standard folder.
 

View a report denition Right-click a report and select View Denition. The report denition opens in a new window.

Add a folder Right-click in the white space of the list and select New Folder. After you name the folder and press
Enter, the new folder displays in the list and also under the parent folder in the tree.

Reorganize folders and items Drag and drop a folder and its contents into another folder and move items from one folder to another
using drag-and-drop. You can also drag folders or items in the list and drop them onto a folder in
the tree. (You cannot, however, drag from the tree to the list, since dragging a folder into one of its
descendants is never permied.)
Certain explorers may not permit drag-and-drop operations.
 

Resize and re-sort columns Drag the left column boundaries to resize columns. Click a column header to re-sort the data in
ascending or descending order.

Explorer Ribbon  
Many of the actions you initiate from the explorer list can also be selected by clicking a buon on the ribbon.

The explorer ribbon contains only the Home tab. Clicking certain buons, such as New and Open, changes the tabs and
buons that are available. The Help buon is located on the far right of the ribbon. Click this buon to access help for
the current task.

Shortcut keys are also available for all ribbon buons so you can enter a key combination to perform an action rather
than clicking a ribbon buon. Press Alt plus the rst leer of the ribbon tab that you want to display shortcut keys for.
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(For instance, press Alt+H to display the shortcut keys for buons on the Home tab.) This is a one-time action. When
you use a shortcut key, the ribbon returns to its default display.

Group/Buon Description

Record

Edit Click this buon to edit the selected item in the list. You can also right-click the item and select Edit or
double-click the item.

Open Click this buon to open the selected item in the list. You can also right-click the item and select Open.

New Report Click this buon to create a custom report.
This buon appears only on the Reports explorer ribbon. Other explorers contain a New buon.
 

New Dashboard Click this buon to create a dashboard.
This buon appears only on the Reports explorer ribbon.
 

Queue Click this buon to manually schedule the report to run in the background. When a queued report has
been generated, a toast notication displays with a link to open the report. (This option is useful for
reports or dashboards that you think may query or return a large amount of data.) You can also right-
click the report and select Queue.
This buon appears only on the Reports explorer ribbon.
 

View Denition Click this buon to view the report denition in a new window. You can also right-click the report and
select View Denition.
This buon appears only on the Reports explorer ribbon.
 

Copy Click this buon to copy the selected item in the list. You can also right-click the item and select Copy.

Delete CAUTION:  Deleting a folder deletes all of its contents as well. This action cannot be reversed.

Click this buon to delete the selected item or folder in the list. You can also right-click the item or
folder and select Delete or select the item and press Delete.
 
You cannot delete a root or standard folder.
 

Rename Click this buon to rename the selected subfolder or item in the list. You can also right-click the item or
subfolder and select Rename.
You cannot rename a root or standard folder.
 

Navigation

Back Click this buon to return to the last folder you accessed. The list on the right populates with the
folder’s contents, just as if you had manually selected a folder in the tree. Initially, this buon is
disabled. You can also click the arrow on the far right of the address bar to display the paths of the last
ten folders and items accessed. The most recent entry is at the top of the list.

Forward Click this buon to move forward in the history of recently accessed folders and items. The forward list
is populated as soon as you click the Back buon. You can also click the arrow on the far right of the
address bar to display the paths of the last ten folders and items in the Forward list. The most recent
entry is at the top of the list.

Up Click this buon to access the parent of the selected folder. When the selected folder has no parent
(that is, it is a root folder), the Up buon is disabled.
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Group/Buon Description

Refresh Click this buon to refresh the tree and list.

Find Click this buon to change the explorer state to Search On. See Explorer Display States.

Display

Folders Click this buon to switch between showing the tree and hiding it.

Views Click the arrow on this buon to change the way the subfolders and items display in the list. Options
include Tiles, Icons, List, and Details. The default is Details (subfolders and items display in column
format).

Choose Details Click this buon to select which database columns you want to display and which you want to hide. The
columns that are displayed have a check next to them. This buon is available only when the Details
view is active. (See the Views buon description above.)
The Name column can never be hidden and therefore does not appear in the list of columns. However,
 you can display the ID column, which is hidden by default.
 

Related Topics
• Overview of Creating Basic Custom Reports

• Overview of Dashboards

• Overview of Managing Reports on the Reports Explorer

How You Change Folders from the Address Bar  
You can change folders and focus in the tree by entering a path, or partial path, in the address bar.

As you work in the tree, the address bar is updated with the path of the selected folder whenever you change folders.
Clicking Back or Forward also updates the path in the address bar.

Tip:  You can enter just a few characters in the address bar and the system will present you with possible path
completions. Use your mouse or other pointing device or the arrow key to select the path you want. Then
press Enter or click Go to change folders.

Save an Item in an Explorer  
When you create or edit an item in an explorer, you have more than one option for saving the item. No maer which
explorer you are working with, the steps are essentially the same.

1. Click the Home.

Note:  When saving a custom report, click the arrow on Save on the Quick Access toolbar and select a
save option.

2. To save changes to the item without closing it, click Save.
3. To save changes to the item and close it, click Save and Close.

This option is faster than saving a change and then manually closing the window.
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4. To save a new item or save a copy of the item you are editing with a dierent name, click Save As. The Save As
window opens.

Note:  Not all explorers contain a Save As buon.

a. To save the item in a custom folder, navigate to the folder. You cannot save custom items in the standard
folders in either the Reports or Images explorers.

b. Enter a name for the item in the Name eld.
c. Click OK.

Session Management and Login Controls  

Overview of Session Management and Login Controls  
Oracle Service Cloud provides a number of security measures to assist you in safeguarding your organization’s data and
that of your customers.

As your organization’s administrator, you can expire sessions to help reduce session exploitation, control both active
and inactive desktop user sessions to lower seat usage for licensing compliance, and control and track login behavior on
the administration interface.

How You Force Session Expiration  
This topic describes how to force session expiration for sta members.

Reducing session exploitation can help your organization protect its data. And Oracle Service Cloud is set up to
automatically expire sessions so you can control the length of time before sta sessions expire. Although you have
other ways to force sta members to reauthenticate, the session hard timeout feature should be the primary method
you use since it requires no manual intervention on your part.

The SESSION_HARD_TIMEOUT conguration seing (RightNow User Interface/General/Security) can be set for a
time value between a minimum of 1 hour and a maximum of 8,760 hours (1 year). The default value is 12 hours.

A warning message alerts sta members ve minutes before their current session is set to expire and tells them to
reauthenticate. After entering login credentials, the sta member will be authenticated, a new session will be created,
and the session ID will be updated throughout the product. The sta member can continue working without any loss of
data.

Note:  Desktop Add-Ins (.NET API), Connect Desktop Integration (JavaScript API), and Cobrowse will receive
a notication when a new session has been created. See Desktop Add-Ins (.NET API) and Connect Desktop
Integration (JavaScript API).

If a sta member dismisses the warning message (by clicking Cancel), the Service Console locks when the session
expires. After the sta member enters login credentials and is authenticated, a new session is created and the sta
member can proceed without losing any work.
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Agents who are chaing with customers must also enter their password to reauthenticate. If an agent does not
reauthenticate, any open chat sessions are sent back into the queue for assignment to the next available agent.

Desktop Usage Control  
Our desktop usage administration feature is controlled by the SESSION_MANAGEMENT_ENABLED conguration
seing. This seing is enabled by default and lets you to control and manage both active and inactive sessions.

Contact your Oracle account manager for information about desktop usage metering and licensing compliance.

Log Out a Sta Member Manually  
While session hard timeout is the preferred way to force sta members to reauthenticate, you can also manually log out
individual sta accounts when the situation warrants.

This action terminates the sta member’s session, locks the Service Console, and forces the sta member to
reauthenticate in order to continue working. When an agent is engaged in a chat and is logged out, but then does not
reauthenticate, the chat is sent back into the queue for assignment to the next available agent.
In order to manually log out sta accounts, sta members must have the Groups/Accounts/Distribution Lists
permission on the Administration tab of the Proles editor. See Administration Permissions to assign this permission.

When you manually log out a sta account, the server sends the information to the client. When the sta member then
tries to perform an action, like saving an open record or clicking a buon, a Console Locked message displays. After the
sta member enters login credentials and is authenticated, a new session is created and the sta member can proceed
without losing any work. Also, the end date and time are updated in the User Transactions (user_trans) table in the
Oracle database, enabling you to view and track your desktop user sessions.

Using the Logged In Sta Accounts standard report, you can see which sta members are currently logged in, the date
and time they logged in, and how long they have been logged in. You’ll also see a Force Logout buon on the Record
group of the ribbon for logging out a selected sta account. (You can also right-click a sta account in the list and select
Force Logout.)

Note:  If you prefer, you can create your own custom report to manually log out sta members. You’ll need to
use elds from the Accounts (accounts) and User Transactions (user_trans) tables to display currently logged-
in sta accounts and their login start and end times.

1. Do one of the following:

◦ From the conguration list, double-click Logged In Sta Accounts in Sta Management.

◦ From the Reports explorer, double-click Sta Management in Common/Site Administration.

2. Select a sta account in the list and click Force Logout.
A message asks you to conrm the action and warns you that all of the sta member’s unsaved changes will be
lost.

3. Click OK.
A message tells you that the sta member’s session has been terminated.

4. Click OK.
5. Repeat the previous steps as necessary to log out additional sta accounts.
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When a sta member tries to perform an action after being logged out, a Console Locked message displays. After the
sta member reauthenticates (by entering the correct password), a new session is created and the sta member can
proceed without losing any work.

Automatically Logging Out Inactive Sessions  
In addition to manually logging out active sessions, you can also set up your application to automatically log out
inactive sessions.

You’ll congure automatic logout of inactive sessions using a conguration seing and a prole seing, which work
together to give you more exibility in managing your desktop user sessions and maintaining site security.

• CLIENT_SESSION_EXP—Use this conguration seing to specify the time in one-minute intervals that a session
can be inactive before a sta account is automatically logged out. The default value of CLIENT_SESSION_EXP
(RightNow User Interface/General Security) is 15 minutes and the maximum value is 1440 (24 hours).

Even if you disable desktop usage administration, you can still use CLIENT_SESSION_EXP to maintain security
on your site.

• Session Timeout eld—Use this eld on the Proles editor to specify a time (0–1440 minutes) other than the
time dened in CLIENT_SESSION_EXP that a session can be inactive before a sta account is automatically
logged out, or set this eld so that sta members with a particular prole are exempt from being automatically
logged out due to inactivity. By default, this eld is null, meaning that the value in CLIENT_SESSION EXP will be
used for automatic logout. Entering any value in this eld overrides the value dened in CLIENT_SESSION_EXP.

Note:  Even if you exempt certain sta members from being automatically logged out due to
inactivity, sta member sessions will still expire and sta must reauthenticate when the time set in
SESSION_HARD_TIMEOUT expires.

Here’s how automatic logout of inactive sessions works. When the time of inactivity has been exceeded, the client sends
a logout request to the server, which will update the end date and time in the User Transactions (user_trans) table in the
Oracle database.

Sta members will receive a Console Locked message asking for their password to reauthenticate. After a sta member
enters login credentials and is authenticated, a new session is created and the sta member can continue working
without any loss of data.

For sta members who choose to exit the application, all their unsaved work will be lost. In addition, after entering four
incorrect passwords, a sta member will be locked out of the console and must re-launch the application. Any unsaved
work will be lost.

Agents who are chaing with customers when they are automatically logged out must also enter their password to
reauthenticate. If an agent does not reauthenticate, any open chat sessions are sent back into the queue for assignment
to the next available agent.

Note:  Sta members who log in through an identity provider (that is, using the single sign-on process) will not
have the opportunity to re-enter their password to continue working in the application. Any unsaved work will
be lost.
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Congure Automatic Logout by Prole  
This topic describes how to congure automatic logout based on a specic prole.

You may want to exempt certain personnel from an automatic logout, or you may want to change the time that a
session can be inactive before a sta account is automatically logged out. Either way, you can customize automatic
logout by prole to override the time set in CLIENT_SESSION_EXP.

Note:  When SESSION_MANAGEMENT_ENABLED is disabled, this prole seing is disregarded.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Select the prole you want to edit and click Open.
4. Click the Other tab to display the Session Timeout eld.

The default value of the Session Timeout eld is null, meaning that the value specied in
CLIENT_SESSION_EXP will be used for automatic logout. Change the null default only if you want to override
the value in CLIENT_SESSION_EXP.

5. To exempt sta members associated with this prole from being automatically logged out, enter 0 in the eld.
6. To set another value, which will override the value specied in CLIENT_SESSION_EXP, enter the number of

minutes in the eld.

Note:  Even if the value in CLIENT_SESSION_EXP is set to 0, any value other than 0 in the Session
Timeout eld will be used to automatically log out sta members associated with this prole when the
minutes of inactivity have been exceeded.

7. Click Save.
8. Repeat this procedure for all the proles you want to congure for automatic logout.

Related Topics
• Overview of SAML 2.0 Open Login

Login Help Options  
You have a number of options that can be added to your application to control login behavior and assist sta members
when logging in. You can also add your organization’s branding to the Login window to communicate a message to your
sta members.

Oracle Service Cloud contains an account self-service feature to assist sta members who are having problems logging
in. Sta members access this feature using the Login Help link on the Login window.

Using ACCT_RECOVER_ALT and ACCT_RECOVER_STATUS (RightNow User Interface/Tool Bar/General), you can
congure your application to perform one of the following actions when sta members click Login Help.

• Open the login procedure in online help—In addition to providing the steps required to log in, this procedure
directs sta members to their organization’s administrator for their login information and explains the default
behavior of the account self-service feature.
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• Send sta an email if they have forgoen their user name or password—This is the default in
ACCT_RECOVER_STATUS. When sta members click Login Help, the Account Self Service window opens.

Sta members who have forgoen their user name simply enter their email address and click Submit. If their
email address is unique, they will receive an email containing their user name. If not unique, they will receive an
email telling them to contact their administrator.

Sta members who have forgoen their password select I Forgot My Password. An additional eld displays.
Sta members must enter their email address and user name. If both email address and user name match
what’s dened in their sta account, they will receive an email containing a link to the Password Reset page for
entering a new password. As a security measure, if either user name or email is incorrect, no email is sent.

Note:  Use the Accounts email messages (Site Conguration/Message Templates/Administrator Emails/
Accounts) to customize the emails sent to sta members when they have forgoen either their user name or
their password.

• Show alternate message—If you want to display an alternate message to sta members when they click Login
Help, change the value in ACCT_RECOVER_STATUS to 2 and enter your new message in ACCT_RECOVER_ALT.

Related Topics
• How You Customize Conguration Seings

How You Add Your Branding on the Login Window  
The Login window is an ideal place for you to communicate a message to your sta.

Using our branding feature, you can include any message content you want when sta members log in to your
application. And if your site is congured for multiple interfaces, you can customize each interface’s Login window
according to its audience and the message you want to convey.

Two areas can be customized using the following conguration seings. (Expand Site Conguration, double-click
Conguration Seings, and then locate RightNow User Interface/Tool Bar/General.)

• BRAND_CONTENT_URL—Species the URL used to display content on the banner area of the Login window.
The default contains Oracle content announcing releases, webinars, and events.

Tip:  Make sure to enter a fully qualied domain name to display the web page you want. Also, the web
page must use fully qualied paths to images, or the images will not display.

• BRAND_WELCOME_MSG—Species the welcome message displayed on the Login window. Default is blank.
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Related Topics
• How You Customize Conguration Seings

• Overview of Multiple Interfaces

How You Provide Login Information to Sta Members  
You can provide sta members with details about their login activity for the previous sixty days.

The My Account Login Statistics report, located in Common/Site Administration/Sta Management, lists when
the sta member last logged in successfully, the IP address of the last successful login, when the last login aempt
failed, and the IP address of the last failed login aempt. A drill-down is also available that lists all the unsuccessful login
aempts since the last successful login.

You may also want to add the My Account Login Statistics report to your sta members’ navigation sets. In addition,
if you set this report as the default in a navigation list, and that navigation list displays when sta members log in, the
report will automatically open on the content pane. In this way, your sta can track their own login activity on a regular
basis.

The sta member’s name in the Account column on the My Account Login Statistics report links to the Unsuccessful
Login Aempts by Account report, another standard report in Oracle Service Cloud. While sta members can see their
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individual unsuccessful login aempts in this report, you can run the report to see all failed login aempts throughout
your system and spot any trends or problems that may exist.

Administration Login Limits  
You can control the number of concurrent administration logins per site.

Any range between 1 and 40,000 is allowed, and 40,000 is the default. Limiting the number of allowed sessions per
site can help you manage system resources. Contact your Oracle account manager to change the default seing. See
Desktop Usage Control to learn about the other ways to manage and control desktop user sessions.

Sta Account Locking  
By default, the system locks a sta account after the sta member enters an incorrect password ve times.

This measure can help you and your organization maintain site security. You can change any of the password
requirements using the Password Conguration editor accessed when you click Conguration on the navigation pane
and expand Sta Management. See Congure Sta-Member Passwords.

Related Topics

Login Agreement Functionality  
You can distribute a terms of use agreement, a security statement, or any login message you choose to sta members
accessing the administration interface.

Your message or statement will display after sta members click Login on the Login window. Sta members must
agree to the statement or message before the Service Console opens. To review or change your message, see the
LOGIN_SECURITY_MSG conguration seing (RightNow User Interface/Tool Bar/General).

How You Save Login Credentials  
For security purposes, sta members must enter their user name and password each time they log in.
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If you want to provide sta members with the option to save their login credentials, enable the
ACCT_ALLOW_REMEMBER_ME conguration seing (RightNow User Interface/Tool Bar/General). Thereafter, each
sta member’s browser control will handle the user’s login credentials using auto complete.

Related Topics
• Search for a Conguration Seing

• Congure Sta-Member Passwords

Navigation Sets  

Overview of Navigation Sets  
Navigation sets control the navigation lists and buons that sta members see on the navigation pane of the agent
desktop.

Every sta member has a prole, and every prole must include a navigation set that all sta members with that
prole use when they work in Oracle Service Cloud. A navigation set is a combination of navigation buons and their
associated navigation lists. If you do not create navigation sets and assign them to proles, sta members will not have
access to navigation buons and lists.

You can perform any of these tasks:

• Congure navigation sets to provide access to only areas of the system that sta members need to perform
their job.

For example, an agent working in your technical support group probably does not need access to marketing
campaigns or sales opportunities. In that case, navigation lists for Campaigns and Opportunities can be left o
their navigation sets.

• Create as many navigation sets as your organization needs.

When you add a prole, you select the navigation set that sta members with the prole will use. The sta
members assigned to the prole have access to only those reports and items dened in their prole navigation
set unless you allow sta members with that prole to customize their navigation set. See Add or Edit a Prole
and How You Customize Navigation and Conguration Lists

• Add reports and components to the navigation buons.

You also can add Quick Search reports to navigation sets to allow searching for contacts, incidents, or other
types of records directly from the navigation pane. The rst time you open the Navigation Sets explorer, the
right side is generally empty because no navigation sets have been created.

After you create navigation sets, the explorer displays the tree structure on the left and navigation sets on the right. The
explorer includes options to copy, edit, delete, and rename any navigation set that you create. Public and private reports
and dashboards can be added to navigation buons. However, sta members must have the appropriate Analytics
permissions in their prole to open them.

The Navigation Sets explorer does not contain standard folders, but you can create custom folders to help keep your
navigation sets organized. For information about working with folders, see Add Folders. For detailed information about
explorer functionality, see Open the Reports Explorer.
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To understand how navigation sets, proles, and sta accounts work together, see Navigation Sets, Proles, and Sta
Accounts.

If your installation of Oracle Service Cloud contains multiple interfaces, also see Sta Member Accessibility.

Create a Navigation Set  
Follow this procedure to create a navigation set.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer opens.
3. Click New.

The Navigation Sets editor opens on the content pane.
By default, the File Menu component is selected on the right side of the content pane and New Items displays
on the left. When any other component or record type is selected on the right, the left side of the content pane
displays Public Reports and Components.

4. To enter information about the navigation set, enter a description in the Summary eld.
You name the navigation set when you save it.

5. To set the options available through the le menu, see Congure the File Menu.
6. On the right side of the content pane, select the check boxes next to the types of records or components you

want to include in the navigation set.
All are selected by default. Separate navigation lists can be created for each type of record or component you
select. For example, select the Incidents check box to include a navigation list sta members can use when
they work on incidents. You cannot clear the check box next to the File Menu component, because the le
menu is always available.

7. Click one of the selected record types or components to begin creating a navigation list for the record type or
component.

Note:  Most navigation lists for the navigation buons you select are initially empty when creating
a navigation set. However, the navigation list for the Conguration buon is populated with default
conguration items. The items in this list can be customized using the same functionality used to
customize the other navigation lists. See Create a Navigation Set for the Administrator.

8. On the left side of the content pane, expand Public Reports and Components and then expand the subfolders
to see the available items. If you know the name of a report or component (or part of the name) you want to
add to a navigation list, you can quickly locate it by clicking Find in List and searching for the item.

9. To add reports and dashboards to the navigation list do one of the following:
◦ Select the reports you want to add from the left column and drag them to the lower portion of the right

column.
◦ Double-click or select the reports or components you want to add and click Add.

To add more than one item at the same time, press Ctrl while selecting each item.
10. To add explorers to the navigation list, select the navigation item you want to add the explorer to from the right

column, expand Components in the left column, expand the folder for the explorer you want to add, and drag it
to the lower portion of the right column.

11. To add notications to the navigation list, expand the Common folder under Components in the left column,
select Notications, and drag it into the lower portion of the right column.
This lets sta members open any notications they receive. See Notications.

12. To add a folder to the navigation list to help organize items in the list, click New Folder.
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a. Enter the name you want for the folder.
b. Drag explorers, reports, or other items to the folder.
c. To rename a folder, click the folder, click Rename, enter the new name for the folder, and click outside the

folder name to save the new name.
13. To set a report, explorer, or other item as the default for this navigation list, right-click it and select Set As

Default. See Available Actions from a Navigation or Conguration List.

Note:  The default item for a navigation list opens on login only if the navigation list was the active list
when the sta member logged out last time. See Change Your Navigation Pane Seings for how sta
members can change this behavior.

14. To create a navigation list for each type of record that you want to be available in the navigation set, repeat
steps 7 through 13.

15. To choose the order in which the navigation buons display on the navigation pane, click a record type or
component on the upper portion of the right column and click Move Up or Move Down to position it in the list.

16. To add Quick Search reports to the navigation set, see Add Quick Search Reports to a Navigation Set.
17. Click Save.

The Save As window opens where you can enter a name for the navigation set in the Name eld.
18. Click OK.

Related Topics
• Creating a Navigation Set (video)

Congure the File Menu  
The le menu, accessed by clicking File next to the ribbon’s Home tab, includes a section on the right for creating
records and items. This list is blank until you congure the le menu in navigation sets.

After you have congured it, sta members can click File and use the shortcuts you have added.

If you do not set any options for the le menu in the navigation set, sta members with proles that use that navigation
set do not have the option to create items using this shortcut. Also, if you set menu options for items that the sta
member’s prole does not grant permission for, those options do not appear in the le menu.

1. Click Conguration on the navigation pane.
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2. Expand Application Appearance, and then double-click Navigation Sets.
The Navigation Sets explorer opens on the content pane.

3. Right-click the navigation set you want to congure the le menu for and select Open.
4. If File Menu is not selected at the top of the upper portion of the right column, click it.
5. Expand New Items in the left column.
6. Select the items you want to add to the le menu and click Add.

You can also double-click items to add them. To add more than one item at the same time, press Ctrl while
selecting each item.

7. To add a folder to the le menu to help organize menu items, click New Folder.
a. Enter the name you want for the folder.
b. Drag menu items to the folder.
c. To rename a folder, select the folder, click Rename, enter the new name for the folder, and click outside

the folder name to save the new name.
8. To choose the order in which the menu options appear when File is selected, click an item in the lower portion

of the right column and then click Move Up or Move Down to position it in the list.
9. To group menu options, select File Menu, expand New Items on the left, and then select Horizontal Separator

from the boom of the list.
a. Click Add.
b. Click Move Up and Move Down to position the horizontal separators.

10. Click Save.

Add Quick Search Reports to a Navigation Set  
You can add Quick Search reports to a navigation set so that sta members can access Quick Search from any
navigation list on the agent desktop. These reports allow sta members to open records, even with limited information
and regardless of the type of record they are working on.

When you create a navigation set, you can dene which Quick Search reports appear on the Quick Search drop-down
menu on the navigation pane. The same Quick Search menu appears for every navigation buon in the navigation set.

Note:  Remember that sta members can move or hide the Quick Search tool window and other tool windows
on the navigation pane. For information about changing what appears on the navigation pane, see Change
Tool Window Visibility.

Oracle Service Cloud includes the following predened Quick Search reports.

• Answer Quick Search

• Asset Search

• Campaign Search

• Contact Quick Search

• Contact Quick Search for Dashboard

• Contact to Channel Type Quick Search

• Document Search

• Incident Search

• Mailing Search
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• Outreach Task Search

• Opportunity Search

• Organization Quick Search

• Quick Search Dashboard

• Service Task Search

• Survey Search

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer opens.
3. On the right side of the explorer, right-click the navigation set you want to add Quick Search reports to and

select Open.
4. Do one of the following:

◦ If the Quick Search component check box on the upper portion of the right column is cleared, select it.

◦ If the Quick Search component check box is already selected, click it.

You may need to scroll down to locate Quick Search. If any reports are dened, they appear in the lower portion
of the right column.

The Quick Search component is highlighted.
5. On the left side of the content pane, expand the list under Public Reports.
6. Drag a search report from the left column and drop it in the lower portion of the right column.

You can also add search reports by double-clicking them or by selecting them and clicking Add.
7. Click Save.

Copy a Navigation Set  
After you create a navigation set, you can copy it to use as the starting point for another navigation set.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer opens.
3. On the right side of the explorer, right-click the navigation set you want to copy and select Copy.

The Copy As window opens.
4. To add the copied navigation set to a folder, click the folder name.
5. Enter the name of the copied navigation set in the Name eld.
6. Click the OK.

The copy you added appears on the explorer in the folder you selected.

Edit a Navigation Set  
After you create a navigation set, you can edit it to meet changing needs. For example, you might want to include
additional reports in a navigation set or remove a component from it.

Editing a navigation set used in a prole does not impact sta members who have permission to customize their
navigation sets. See How Custom Navigation Sets Work with Proles.

1. Click Conguration on the navigation pane.
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2. Expand Application Appearance, and then double-click Navigation Sets.
The Navigation Sets explorer opens.

3. Right-click the navigation set you want to edit and select Open.
The navigation set opens on the Navigation Sets editor.

4. Click the record type or component you want to edit. Its navigation list displays in the lower portion of the right
column on the content pane.

5. To add a report, explorer, or other item to the navigation list, expand the list of Public Reports or Components,
drag the item from the left column, and drop it in the lower portion of the right column.

6. To remove a report or item from the navigation list, right-click it and select Remove.
7. Repeat these steps for each navigation list you want to modify.
8. Click Save.

Delete a Navigation Set  
Occasionally, you might nd that a navigation set is no longer required so you decide to delete it.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer opens.
3. Right-click the navigation set you want to delete and select Delete.

Note:  If you try to delete a navigation set used in a prole, a message informs you that deletion is
permanent and cannot be undone. If you delete the navigation set, you must edit the prole to select a
dierent navigation set.

A message opens asking you to conrm deletion of the navigation set.
4. Click Yes to conrm deletion.

How Custom Navigation Sets Work with Proles  
Custom navigation sets give sta members permission to change the items in their navigation lists.

If you assign the Customize Navigation Sets permission in a prole, it is important that you understand what
happens when you edit the navigation set associated with the prole. Some changes you make to the navigation set
automatically override changes made by sta members, while other changes have no eect on the navigation set you
dene.

Tip:  Sta members can reset their navigation set to their prole default navigation set by accessing their
navigation pane seings ( File > Options > Navigation Pane ), and then selecting the Reset Navigation Set to
Prole Default check box. See Change Your Navigation Pane Seings.

We recommend that you consider the following implications when updating navigation sets.

• Changing the default navigation set for a prole resets all navigation lists. All personalized navigation lists are
removed.

• Changing the prole for a specic sta account removes the sta member’s personalized navigation lists.

• Adding or removing buons from navigation sets determines what buons are available on sta members’
navigation sets, even if those sta members have permission to personalize their navigation set. After buons
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are added to or removed from navigation sets, the changes are applied to sta members’ navigation sets the
next time they log in to the agent desktop.

• Editing navigation sets to add or remove items, such as reports or explorers, from navigation lists, has no eect
on sta members’ navigation sets if their proles include the Customize Navigation Sets permission. To apply
the changes to those sta members’ navigation sets, you must edit their proles and clear the Customize
Navigation Sets check box. When you do so, all personalized navigation lists are removed and sta members
use the navigation set dened in their prole.

Assign a Navigation Set to a Prole  
After you create navigation sets, you assign them to proles used by your sta members.

You can also assign permission allowing sta members to customize the navigation set to their individual needs.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to assign the navigation set to.

The Proles editor opens.
4. Click Search in the Navigation Set eld, select the navigation set you want sta members with this prole to

use, and click OK.
5. To give sta members permission to change the items in their navigation lists, select Customize Navigation

Sets.
Sta members with this permission can add reports, dashboards, and explorers to their navigation lists and
remove items they do not use. Changes that sta members make to their own navigation set do not impact
other sta members’ navigation sets. However, there are some additional considerations when this permission
is granted. For information about the impacts of assigning this permission, see How Custom Navigation Sets
Work with Proles.

6. Click Save.

Sta Management  

Overview of Sta Management  
Every sta member who accesses or works in Oracle Service Cloud requires a sta account.

Sta management includes these tasks.

• Creating and editing proles

• Creating and editing sta accounts

• Assigning permissions

• Conguring sta-member passwords

Before creating a sta account, you must create a prole for that account. Proles dene the products and information
sta members can work with when logged in to Oracle Service Cloud. Sta accounts include sta-member-specic
information, such as the account login, phone number, and assigned prole. Sta accounts are organized in folders
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according to groups dened by job duties or other criteria, though you can also dene secondary groupings by
manager.

When you create a sta account, you also can specify an initial password, which can later be changed by you or the
sta member after log in. You control the requirements passwords must conform to by dening the minimum password
length, format, expiration options, and the number of invalid logins allowed.

Proles  
Proles let you control what areas of Oracle Service Cloud your sta members can access and what specic actions they
can perform in those areas.

Proles contain general options for Oracle Service Cloud administration functions and more specic options for each
of the products within the system. For example, proles dene whether your sta members can view and edit business
rules. They also dene whether your agents can respond to customers, assign incidents, conduct chat sessions in Oracle
RightNow Chat Cloud Service (Chat), and perform other activities.

Navigation sets and custom workspaces are associated with proles on the Proles editor. While creating and using
custom workspaces is optional, navigation sets must be created and associated with proles before you add sta
accounts. Otherwise, sta members will not have access to any records, reports, or components. See Overview of
Navigation Sets and Overview of Workspaces.

You may decide to dene your proles based on the structure of your organization. For example, you may want separate
proles for administrators, managers, agents, sales representatives, marketing personnel, and knowledge engineers.
After you create proles, you can add sta accounts and assign a prole to each account.

Create the following items before adding proles.

• Navigation sets—Proles without navigation sets do not allow access to reports and other components. See
Create a Navigation Set.

• Custom workspaces (optional)—If you use custom workspaces, we recommend creating them before creating
proles so you can assign workspaces to specic proles. See Create a Workspace.

Add or Edit a Prole  
Use this procedure to add or edit a prole.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane, listing the proles that have already been created.

Tip:  If a prole already exists that is similar to the prole you want to create, you can copy the existing
prole and edit the copy to create the new prole.

3. To add a prole, click New.
The Proles editor opens.

4. To edit an existing prole, double-click the prole.

5. Enter the name of the prole in the Name eld.
When you move to another eld on the content pane, the name you type is automatically added to the Label
eld.

6. From the Interfaces section, select the check boxes next to the interfaces you want the prole to access under
the Access column.
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7. If your site has multiple interfaces, click the interface you want to congure the prole for. The permissions
granted for the rst interface you congure are also granted for all other interfaces the prole can access.

8. Click Search under the Navigation Set column to specify the navigation set you want to use for the prole. The
Select Navigation Set window opens.

a. Select the navigation set from the list.
b. Click OK.

9. To allow the sta accounts associated with the prole to customize their navigation set, select Customize
Navigation Sets check box.

10. By default, standard workspaces are selected in new proles. To assign custom workspaces or workows to the
prole, click the Search icon next to the workspace you want to change. The Workspaces / Workows window
opens.

a. Select the workspace you want to use.
b. Click OK.

Note:  If you do not assign a workspace to a browser editor slot, the workspace or workow from the
non-browser editor will be used. If the non-browser editor row is blank, the standard desktop console
workspace will be used.

11. To grant access to add-ins that are installed on the site, click the Agent Desktop Add-Ins tab.

Note:  Options on this tab are active when add-ins are installed using the Add-in Manager.

a. To let sta members with this prole install add-ins on their workstations without uploading the add-in to
the server, select Developer Access.

This option lets developers test add-ins without the add-ins being downloaded to other sta
members’ workstations. Add-ins must be placed in subdirectories of the %APPDATA%/
RightNow_Technologies/your_site/version/Users/prole_number/AddIns directory. Each add-in
must be contained in a separate subdirectory.

b. To let sta members with this prole use add-ins, select the check boxes next to the add-ins they can
access.

12. To grant access to Agent Browser UI extensions that are installed on the site, click the Agent Browser UI
Extensions tab.

Note:  Options on this tab are active when extensions are installed using the Add-in Manager.

a. To let sta members with this prole use extensions, select the check boxes next to the extensions they
can access.

13. To grant access to installer options, click the Deployment tab.
14. To change the automatic logout seing for sta members with this prole, click the Other tab and enter a value

(in minutes) in the Session Timeout eld.
15. To create a prole for external users to have collaboration-only access, click the Other tab and select the

External User check box.
Service Collaboration must be enabled for this check box to appear.

16. To set the .NET browser control to run in IE11 emulation mode rather than the default IE7 mode, click the Other
tab and select the Set Browser Controls to use IE11 emulation mode check box. Contact your Oracle account
manager to enable this option if you are a new customer.
A warning message appears indicating that this option will change the registry key of the user’s computer
so .NET browser controls in the Oracle Service Cloud application will use IE11 emulation mode, and that the
option should be thoroughly tested before used in production. Click Yes to continue with this option. Agents
must log out and log in again for the registry key to be set.
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Note:  If the Set Browser Controls to use IE11 emulation mode check box has been previously
selected, but is cleared, a warning will be shown indicating that once set, the registry will need to be
manually cleared.

In addition, the Open Pop-ups in New Browser Control and Send URL as Post Data options in workspaces
should be cleared, and No Application should be selected.

17. To grant permissions to the prole, click Permissions.
The Proles Permissions editor opens displaying a number of tabs.

Note:  See Set Prole Permissions to learn about the tabs, and how to use the available options to
assign permissions to a prole.

18. To view an audit log of changes made to the prole, click Audit Log.
19. To add notes to the prole, click Notes.
20. Click Save.

Related Topics
• Overview of Navigation Sets

• When to Use Multiple Interfaces

• How Custom Navigation Sets Work with Proles

• Agent Browser UI Extensions

• Overview of Add-Ins

• Add a Browser to a Workspace or Script

• Creating a Prole (video)

Set Prole Permissions  
Using the tabs on the Prole Permissions editor, you can assign various administrative, read, edit, and delete
permissions to sta members’ proles.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, double-click Proles, and then double-click the prole you want to edit.

The Proles editor opens.
3. Click Permissions.

The Prole Permissions editor opens.
4. Click the tabs to access options and assign permissions.

Click This Tab To Perform This Function

Administration Selected by default when you open the Permissions page.
 

Organizations Assign permissions related to adding and editing organizations.
 

Contacts Assign permissions related to adding and editing contacts.
 

Service Assign permissions related to Service. If Oracle RightNow Chat Cloud Service (Chat) is
enabled on the site, chat permissions are also selected on this tab.
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Click This Tab To Perform This Function

 

Opportunities Assign permissions related to opportunity tracking.
 

Outlook Integration Assign Outlook integration permissions. Outlook integration must be enabled for this
tab to appear.
 

Outreach Assign Oracle RightNow Outreach Cloud Service (Outreach) permissions.
 

Feedback Assign Oracle RightNow Feedback Cloud Service (Feedback) permissions.
 

Tasks Assign task permissions.
 

Custom Objects Assign custom object permissions. Custom objects must be enabled for this tab to
appear.
 

Analytics Assign Analytics permissions.

5. Enter the appropriate eld information.
6. Click Save.

Administration Permissions  
The Administration tab is the default tab on the Prole Permissions editor. By enabling options on this tab, you can
grant sta members permissions related to administrative functions of the system.

You can give permission to congure sta accounts and distribution lists, create and edit agent scripts, access business
process seings, and add and edit business rules. Hover over the permissions on this tab to view the product areas the
permissions impact.

Field Description

Administration
 

These options dene administration permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Administration section.
 

Administration
 

Select this check box to let sta members with this prole access the following options:
• Custom Fields

• Messages

• Mailboxes

• Currencies and Exchange Rates

• Service Level Agreements

• Response Requirements
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Field Description

• Chat Hours

• Channels

• Channel Accounts

• Quote Templates

• Territories

• Promotions

• Strategies

• Sales Periods

• External Suppression List

• Thread Type Correction

• Archive Incidents

 

Groups/Accounts/Distribution Lists
 

Select this check box to let sta members with this prole access the following options:
• Sta Accounts and Groups

• Distribution Lists

 
Sta members who have Groups/Accounts/Distribution Lists permissions can assign only those
proles with the same or lesser permissions as their prole.
 

System Error Log
 

Select this check box to let sta members with this prole access the log les under Site Conguration.
 

Workspace Designer
 

Select this check box to let sta members with this prole access the Workspaces and Workows
explorer and designer.
 

Scripting
 

Select this check box to let sta members with this prole create and edit agent scripts.
 
Agent scripting must be enabled on your site to use this feature. Contact your Oracle account manager.
 

Object Designer
 

Select this check box to let sta members with this prole create and manage custom objects using the
object designer. For information about the Custom Objects tab on the Proles Permissions editor, see
Custom Objects Permissions.
 
Custom objects must be enabled on your site to use this feature. Contact your Oracle account
manager.
 

Message Templates
 

Select this check box to let sta members with this prole edit message templates used to customize
administrator notications, administrator email, and contact email.
 

CP Promote
 

Select this check box to let sta members with this prole promote pages from the staging area to the
production area of the customer portal site, where customers can view them. For this check box to
display, MOD_CP_DEVELOPMENT_ENABLED must be enabled on your site.
 
Sta members with CP Promote permission automatically have CP Edit and CP Stage permissions.
 

CP Stage
 

Select this check box to let sta members with this prole copy development les to the staging area
of the customer portal site. For this check box to display, MOD_CP_DEVELOPMENT_ENABLED must be
enabled on your site.
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Field Description

 
Sta members who have CP Stage permission automatically have CP Edit permission.
 

CP Edit
 

Select this check box to let sta members with this prole access the Customer Portal Administration
site and edit customer portal pages in the development area using WebDAV. For this check box to
display, MOD_CP_DEVELOPMENT_ENABLED must be enabled on your site.
 
Sta members with CP Edit permission, but not CP Stage or CP Promote permission, cannot access the
Customer Portal editor. Nor can they access the Deploy tab on the Customer Portal Administration site.
 

Rules View
 

Select this check box to let sta members with this prole view business rules.
 

Data Import
 

Select this check box to let sta members with this prole import records through the Data Import
Wizard and manage Data Import templates.
 

Process Designer
 

Select this check box to let sta members with the prole create custom processes (object event
handlers) that run when events occur on objects in the system.
 

Bulk Delete
 

Select this check box to let sta members with this prole delete up to 1000 contact, custom object,
 incident, or opportunity records at a time. For details about the Bulk Delete API, see Bulk Delete.
 

Virtual Assistant Edit
 

Select this check box to let sta members with this prole congure the virtual assistant.
 
For this check box to display, your site must be integrated with Oracle RightNow Virtual Assistant Cloud
Service (Virtual Assistant).
 

Broadcast Notication
 

Select this check box to let sta members with this prole send notications to other sta members. If
cleared, the New buon is grayed out on the notications ribbon.
 

Conguration
 

Select this check box to let sta members with this prole access the following options:
• Password Conguration

• Conguration Seings

• Conguration Wizard

• Message Bases

• File Manager

• Interfaces

• Add-In Manager

• Email Address Sharing

 
If cleared, these options are not available.
 
If selected, sta members with this prole can edit message bases for all interfaces on a site, including
interfaces that they do not have permission to access.
 

Business Process Seings
 

Select this check box to let sta members with this prole access the following options:
• Navigation Sets

• Customizable Menus
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Field Description

• Countries

• Products/Categories/Dispositions

• Standard Text

• Variables

• Holidays

• Product Catalog

• Price Schedules

• Tracked Link Categories

 
If cleared, these options are not available.
 

Rules Edit
 

Select this check box to let sta members with this prole edit business rules.
 

Proles
 

Select this check box to let sta members with this prole add and edit proles.
 
Sta members who have access to the Proles permission also have access to all other proles and can
add, edit, or delete those proles without any restrictions.
 

SSO Login (SAML 2.0)
 

Select this check box to let sta members with this prole log in only through an external identity
provider, that is, using a single sign-on process. Several restrictions apply to sta members whose
prole includes this permission.

• CP permissions (CP Promote, CP Stage, and CP Edit) are disabled if they have been enabled.

• Sta members cannot edit development pages in WebDAV.

• Sta members cannot deploy the customer portal.

• Public SOAP API is disabled if it has been enabled.

• Password options on the Account Details page are disabled.

 
Oracle Service Cloud uses the SAML 2.0 protocol for single sign-on. For this check box to display, SSO
Login (SAML 2.0) must be enabled on your site. Contact your Oracle account manager.
 

Skill Edit
 

Select this check box to let sta members with this prole congure advanced routing.
 
For this check box to display, Chat and Smart Interaction Hub must be enabled.
 

Access Control
 

Select this check box to let sta members with this prole access the Access Control editor to congure
permissions for Community Self Service.
 

Agent Browser User Interface
 

The permission in this section lets sta members with this prole access Oracle Service Cloud using
the Agent Browser UI through account authentication.
 

Account Authentication
 

Select this check box to let sta members with this prole access Oracle Service Cloud using the Agent
Browser UI.
 
For this check box to display, Agent Browser UI must be enabled on your site. Contact your Oracle
account manager.
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Field Description

Public SOAP API
 

Permissions in this section let sta members with this prole access the public SOAP API through
account or session authentication.
 

Select All
 

Select this check box to select all check boxes in the Public SOAP API section.
 

Account Authentication
 

Select this check box to let sta members with this prole access the public SOAP API using their sta
account login user name and password.
 

Session Authentication
 

Select this check box to let sta members with this prole access the public SOAP API using their sta
account login user name and session ID from the agent desktop when agents are logged in.
 

Public Knowledge Foundation API
 

Permissions in this section let sta members with this prole access the public Knowledge Foundation
API through account or session authentication.
 

Select All
 

Select this check box to select all check boxes in the Public Knowledge Foundation API section.
 

Account Authentication
 

Select this check box to let sta members with this prole access the public Knowledge Foundation API
using their sta account login user name and password.
 

Session Authentication
 

Select this check box to let sta members with this prole access the public Knowledge Foundation
API using their sta account login user name and session ID from the agent desktop when agents are
logged in.
 

Related Topics
• Considerations When Using Single Sign-on

• Assign Permissions for Customer Portal

Organization Permissions  
The Organizations tab lists the possible Service, Outreach, and Opportunities states for organizations. It denes
permissions for the sta members with this prole to read, edit, or delete organizations that are in the selected states.

The state of an organization can be manually set by sta members when adding or editing an organization, or
automatically by the system based on how the organization was added. For example, an organization that has been
added while creating an incident defaults to the Service state.

There are seven states:

• Service

• Outreach

• Opportunities

• Opportunities & Outreach

• Service & Outreach

• Service & Opportunities

• Service & Opportunities & Outreach
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When you dene the permissions by state on the Organizations tab, consider which sta members should be able
to take actions on organizations in the various states. For example, you might give agents read and edit access to
organizations in any state that includes Service. However, you may decide that you do not want them to delete any
organizations in the Service & Opportunities, Service & Outreach, and Service & Opportunities & Outreach states.

Field Description

Organizations
 

These options dene the organization permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Organizations section.
 

Add Organizations
 

Select this check box to let sta members with this prole add organizations.
 

Permission by organization state
 

Organizations are classied by their state, which can be Service, Outreach, Opportunities, or any
combination of the three. In this section, set the permissions for sta members with this prole to view,
 edit, and delete organizations in these states and combinations of states.
 
Click the Read, Edit, or Delete buon above a column to select or clear all check boxes in the column.
 

Read
 

Select these check boxes to let sta members with this prole view organizations in the specied state.
 

Edit
 

Select these check boxes to let sta members with this prole edit organizations in the specied state.
 

Delete
 

Select these check boxes to let sta members with this prole delete organizations in the specied
state.
 

Thread
 

These options determine if sta members can modify notes in organization records.
 

Select All
 

Select this check box to select all check boxes in the Thread section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to an
organization record.
 

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to an organization record.
 

Related Topics
• Add an Organization

Contacts Permissions  
The Contacts tab lists the possible Service, Outreach, and Opportunities states for contacts. It denes permissions for
the sta members with this prole to read, edit, delete, or move contacts that are in the selected states.

Sta members can manually set the state of a contact when adding or editing a contact record, or automatically by the
system based on how the contact was added. For example, a contact who enters the system needing customer support
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would initially be classied in the Service state. If the contact expresses interest in a sales product and an opportunity is
created, the contact’s state changes to Service & Opportunities.

Field Description

Contacts
 

These options dene the contact permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Contacts section.
 

Add Contacts
 

Select this check box to let sta members with this prole add contacts.
 

Email Contacts
 

Select this check box to let sta members with this prole email contacts from an open contact record
or from the Contacts tab of an associated record.
 
With this permission, a sta member can click Send Email to the right of the Email eld on a contact
record or the Contacts tab to open a new message in their default email client (outside of Oracle
Service Cloud). The To eld in the new message is populated with the contact’s email address.
 

Access Control
 

Select this check box to let sta members with this prole assign role sets to contacts for Community
Self Service.
 

Permission by contact state
 

Contacts are classied by their state, which can be Service, Outreach, Opportunities, or any
combination of the three. In this section, set the permissions for sta members with this prole to view,
 edit, delete, and move contacts in these states and combinations of states.
 
Click the Read, Edit, Delete, or Move column headers to select or clear all check boxes in the column.
 

Read
 

Select these check boxes to let sta members with this prole view contacts in the specied state.
 

Edit
 

Select these check boxes to let sta members with this prole edit contacts in the specied state.
 

Delete
 

Select these check boxes to let sta members with this prole delete contacts in the specied state.
 

Move
 

Select these check boxes to let sta members with this prole move contacts to dierent organizations.
 

Thread
 

These options determine if sta members can modify notes in contact records.
 

Select All
 

Select this check box to select all check boxes in the Thread section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to a
contact record.
 

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to a contact record.
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Related Topics
• Add a Contact

Service Permissions  
Prole seings on the Service tab let you dene permissions for handling incidents, answers, assignments, assets, social
monitoring, SLAs, and guided assistance guides.

They also let you specify the queues sta members can access, the queue rank, pull policies and quantities, and inbox
limits. If Chat is enabled, additional prole permissions display on the Service tab. See Add Chat Permissions to a Prole.

Field Description

Incidents
 

These options dene the incident permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Incidents section.
 

Read
 

Select this check box to let sta members with this prole view incidents.
 

Add/Edit
 

Select this check box to let sta members with this prole add incidents and modify existing incidents.
If cleared, incidents are read-only when opened and sta members cannot edit elds or send
responses.
 

Send Response
 

Select this check box to let sta members with this prole respond to incidents through email. If
cleared, sta members can add responses to an incident, but cannot send responses to contacts
through email.
 

Delete
 

Select this check box to let sta members with this prole delete incidents. If cleared, the Delete buon
is unavailable and sta members cannot delete incidents.
 

Propose
 

Select this check box to let sta members with this prole propose incidents as answers. If cleared, the
Propose buon is unavailable on the incidents ribbon.
 

Collaboration
 

Select this check box to let sta members with this prole collaborate with other sta members on
incidents.
 
For this check box to display, Service Collaboration must be enabled on your site.
 

Edit/Delete Commied Thread Content
 

Select this check box to let sta members edit incident-thread content and delete images.
 

Incident Queues
 

Select a queue you want to be available for this prole from the drop-down menu and click Add (+). If
needed, you can then select additional queues to associate with this prole, delete queues, or change
their order to reect queue priority ranking.
 

Pull Policy
 

Click this drop-down menu to select a pull policy that determines the queues that incidents are
retrieved from and their order. The pull policies include:
 
Manual—Lets sta members manually pull incidents from any queues available to them, allowing
them to select a particular queue. Incidents are pulled from the selected queue in order of due date.
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Field Description

Strict priority—Uses the priority ranking of the available queues to determine which queue to pull
incidents from, starting with the highest ranking queue. Incidents are pulled from this queue until the
sta member’s pull quantity is met, the sta member’s inbox limit is met, or the queue is empty. If
the queue is empty before the sta member’s pull quantity is met, then incidents are pulled from the
queue with the next highest priority ranking.
 
First due—Uses the incident due date to determine which incidents to retrieve, pulling incidents that
are nearest to their due date rst. Incidents are pulled from all the sta member’s available queues in
the order of due date until the sta member’s pull quantity is met, the sta member’s inbox limit is
met, or all queues are empty. Queue ranking does not aect the pull order.
 

Pull Quantity
 

Enter the number of incidents to be retrieved from the queues at one time when a sta member with
this prole pulls incidents. The maximum pull quantity is 99.
 

Inbox Limit
 

Enter the number of incidents that can be in a sta member’s inbox at one time. The maximum inbox
limit is 999.
 

Pull From Single Round Robin Logged In
Queue
 

Select this check box to specify that sta members with this prole will be assigned new incidents
from the same round-robin logged-in queue in which the most recently solved incident originated.
When the check box is not selected, all round-robin logged-in queues are considered when assigning
incidents.
 
This seing has no eect when sta members manually pull incidents using the Fill Inbox feature.
 

Advanced Routing - Incident Queues Click to select the advanced routing incident queue you want to be available for this prole, and click
+. After selecting a queue, click the drop-down menu to designate it as Primary or Overow and its
order of priority. The queue can be moved up or down in the queue list. If needed, you can then select
additional advanced routing incident queues to associate with this prole.
Pull policy must be set to strict priority or rst due for advanced routing of incidents.
 
Advanced routing must be enabled for this option to appear.
 

Answers
 

These options dene the answer permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Answers section.
 

Add/Edit
 

Select this check box to let sta members with this prole add and update answers.
 
With this check box selected, you must also select HTML Design Mode and/or Source Mode.
 

Delete
 

Select this check box to let sta members with this prole delete answers. If cleared, the Delete buon
is unavailable and sta members cannot delete answers.
 

Set to Public Status
 

Select this check box to let sta members with this prole set answers to the Public status and make
them available to customers. If cleared, the Public option in the Status drop-down menu is not available
when adding or editing answers.
 
While a sta member without this permission cannot change an answer’s status to Public, existing
public answers can still be edited as long as the sta member has the Add/Edit permission.
 

HTML Design Mode
 

Select this check box to let sta members with this prole create an HTML answer in design mode. If
cleared, the Design tab does not display and sta members cannot edit in this mode.
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Field Description

With this check box selected, you must also select Add/Edit.
 

Source Mode
 

Select this check box to let sta members with this prole create an answer in HTML source code. If
cleared, the Source tab does not display and sta members cannot edit in this mode.
 
With this check box selected, you must also select Add/Edit.
 

Model Questions
 

Select this check box to let sta members with this prole add and delete model questions when
creating answers.
 
Your site must be integrated with Oracle RightNow Virtual Assistant Cloud Service (Virtual Assistant) in
order to use this feature. Contact your Oracle account manager.
 

Answer Thread
 

These options determine if sta members can modify notes in answers.
 

Select All
 

Select this check box to select all check boxes in the Answer Thread section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to
answers.
 

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to answers.
 

Assignment
 

These options dene whether sta members with this prole are available for record assignment and
whether they can assign records to other groups.
 

Select All
 

Select this check box to select all check boxes in the Assignment section.
 

Appears in Menus
 

Select this check box to display sta accounts associated with this prole in assignment menus when
adding or editing incidents and answers. If cleared, sta members with this prole are not available in
the Assigned drop-down menu.
 

Assign to Other Groups
 

Select this check box to let sta members with this prole assign incidents and answers to other
groups. If cleared, the Assigned drop-down menu when adding and editing incidents and answers
contains only those selections from the sta member’s group.
 

Asset
 

These options dene the asset permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Asset section.
 

Read
 

Select this check box to let sta members with this prole view assets.
 

Add
 

Select this check box to let sta members with this prole add assets.
 

Edit
 

Select this check box to let sta members with this prole update existing assets. If cleared, assets are
read-only when opened and sta members cannot edit elds.
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Field Description

Delete
 

Select this check box to let sta members with this prole delete assets. If cleared, the Delete buon is
unavailable and sta members cannot delete assets.
 

Social Monitor
 

These options dene the social monitoring permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Social Monitor section.
 

Social Monitor—Search
 

Select this check box to give sta members access to the social monitor controls to search the social
cloud.
 
Oracle RightNow Social Monitor Cloud Service must be enabled on your site to use this feature. Contact
your Oracle account manager.
 

Ignore Results
 

Select this check box to let sta members with this prole ignore social cloud search results. If cleared,
 the Ignore Result buon is unavailable and sta members cannot ignore social cloud search results.
 

More Options
 

These options dene whether sta members with this prole can apply SLAs and guides to records.
 

Select All
 

Select this check box to select all check boxes in the More Options section.
 

SLA—Add/Disable/Delete
 

Select this check box to let sta members assign SLA instances to contacts and organizations, and
deactivate and delete SLA instances.
 

Guided Assistance—Add/Edit
 

Select this check box to let sta members add the guided assistance control to an incident workspace
or customer portal pages, and to edit the guided assistance control.
 
Guided assistance must be enabled to use this feature. Contact your Oracle account manager.
 

Related Topics
• Service Collaboration

• How You Add Answers for Multiple Interfaces

• Assign Asset Prole Permissions

Opportunities Permissions  
Options on the Opportunities tab include permissions for adding and editing opportunities, adding and editing sales
periods and quotas, and permissions to access additional features with opportunities and leads.

Field Description

Opportunities/Leads
 

These options dene the opportunity and lead permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Opportunities/Leads section.
 

Read Select this check box to let sta members with this prole view opportunities.
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Field Description

   

Edit
 

Select this check box to let sta members with this prole edit existing opportunities. If cleared,
opportunities are read-only when opened and sta members cannot edit elds or send quotes.
 

Send Quote
 

Select this check box to let sta members with this prole send quotes with opportunities.
 

Edit Sent Quote
 

Select this check box to let sta members with this prole edit a sent quote.
 

Delete
 

Select this check box to let sta members with this prole delete opportunities. If cleared, the Delete
buon is not available and sta members cannot delete opportunities.
 

Add
 

Select this check box to let sta members with this prole add opportunities. If cleared, the New buon
is not available and sta members cannot add opportunities.
 

Edit Closed
 

Select this check box to let sta members with this prole update the closed date and closed value
elds of opportunities.
 
Selecting the Edit Closed check box automatically activates the Read and Edit check boxes if they are
not already selected.
 

Mark Quote as ‘Accepted’
 

Select this check box to let sta members with this prole select Accepted as the status of a quote
when adding or editing quotes. If cleared, the Accepted option is not available.
 

Reject Leads
 

Select this check box to let sta members with this prole reject leads.
 

Edit Sales Period
 

Select this check box to let sta members with this prole add and edit sales periods, including quotas
on the Sales Periods editor. If cleared, sta members cannot access the Sales Periods editor unless
their prole has the Administration permission enabled on the Administration tab.
 

Thread
 

These options determine if sta members can modify notes in opportunity records.
 

Select All
 

Select this check box to select all check boxes in the Thread section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to an
opportunity.
 

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to an opportunity.
 

Assignment
 

The option in this section denes whether opportunities can be assigned to sta members with this
prole.
 

Appear in Menus
 

Select this check box to display sta accounts associated with this prole in the Assigned drop-down
menu when adding or editing leads and opportunities, as well as the Salesperson drop-down menu
when adding or editing contacts and organizations.
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Outreach Permissions  
You can set options on the Outreach tab to grant permissions to add, update, and delete mailings, campaigns, and
documents.

You also can allow sta members with this prole to create templates, snippets, le aachments, and tracked links.

Field Description

Mailings
 

These options dene the mailing permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Mailings section.
 

Read
 

Select this check box to let sta members with this prole view mailings.
 

Add/Edit
 

Select this check box to let sta members with this prole create mailings and modify existing
mailings. If cleared, mailings are read-only when opened and sta members cannot edit elds.
 

Delete
 

Select this check box to let sta members with this prole delete mailings. If cleared, the Delete buon
is not available and sta members cannot delete mailings.
 

Launch/Suspend/Close
 

Select this check box to let sta members with this prole launch or suspend a mailing, relaunch a
suspended mailing, and cancel a mailing.
 

Modify Opt-in Seing
 

Select this check box to let sta members with this prole change the Honor Global Opt-in seing
when creating or editing a mailing.
 

Modify Frequency Seing
 

Select this check box to let sta members with this prole change the Limit Frequency of
Communication seing when creating or editing a mailing.
 

Modify Recency Seing
 

Select this check box to let sta members with this prole change the Limit Recency of Communication
seing when creating or editing a mailing.
 

Modify Suppression Seing
 

Select this check box to let sta members with this prole change the Honor External Suppression List
seing when creating or editing a mailing.
 

Campaigns
 

These options dene the campaign permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Campaigns section.
 

Read/Add/Edit/Delete
 

Select this check box to give sta members with this prole access to Campaign, including the ability to
add, edit, and delete campaigns.
 

Edit Campaign Status
 

Select this check box to let sta members with this prole modify the status of campaigns.
 

Edit Launched
 

Select this check box to let sta members with this prole edit launched campaigns.
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Field Description

Thread
 

These options determine if sta members can modify notes in campaigns, mailings, or documents.
 

Select All
 

Select this check box to select all check boxes in the Threads section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to a
campaign, mailing, or document.
 

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to a campaign, mailing, or document.
 

Documents
 

These options dene the document permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Documents section.
 

Read/Add/Edit/Delete
 

Select this check box to let sta members with this prole read, add, edit, and delete documents.
 

Approve
 

Select this check box to let sta members with this prole approve documents. If cleared, the Approved
check boxes cannot be selected by sta members when adding or editing documents.
 

Edit Approved
 

Select this check box to let sta members with this prole edit a document that has been approved. If
cleared, sta members cannot edit documents if the Approved check box has been selected.
 

HTML Design Mode
 

Select this check box to let sta members with this prole use the HTML editor in design mode. If
cleared, the Design tab does not display and sta members can edit only in source mode.
 

Content Library
 

These options dene the content library permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Content Library section.
 

Templates
 

Select this check box to let sta members with this prole view, add, edit, and delete templates.
 

Snippets
 

Select this check box to let sta members with this prole view, add, edit, and delete snippets.
 

File Aachments
 

Select this check box to let sta members with this prole view, add, edit, and delete les.
 

Tracked Links
 

Select this check box to let sta members with this prole view, add, edit, and delete tracked links.
 

Audiences
 

These options dene the audience permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Audiences section.
 

Segments
 

Select this check box to let sta members with this prole add, edit, and delete segments.
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Field Description

Contact Lists
 

Select this check box to let sta members with this prole add, edit, and delete contact lists.
 

Assignment
 

The option in this section denes whether records related to Outreach can be assigned to sta
members with this prole.
 

Appear in Menus
 

Select this check box to display accounts associated with this prole in the Assigned drop-down menu
when adding or editing campaigns, mailings, or documents.
 

Feedback Permissions  
You can use the Feedback options to give sta members permission to add, edit, and delete surveys and questions.

You also can specify permissions for enabling and disabling surveys and editing questions that have already been
answered by customers.

Field Description

Survey
 

These options dene the survey permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Survey section.
 

Read/Add/Edit
 

Select this check box to let sta members with this prole view, create, and edit surveys.
 

Delete
 

Select this check box to let sta members with this prole delete surveys. If cleared, the Delete buon
is not available and sta members cannot delete surveys.
 

Disable/Enable
 

Select this check box to let sta members with this prole enable and disable surveys.
 

Launch/Suspend/Close
 

Select this check box to let sta members with this prole launch or suspend a survey, relaunch a
suspended survey, and cancel a survey.
 

Modify Opt-in Seing
 

Select this check box to let sta members with this prole change the Honor Global Opt-in seing
when creating or editing a survey.
 

Modify Frequency Seing
 

Select this check box to let sta members with this prole change the Limit Frequency of
Communication seing when creating or editing a survey.
 

Modify Recency Seing
 

Select this check box to let sta members with this prole change the Limit Recency of Communication
seing when creating or editing a survey.
 

Modify Suppression Seing
 

Select this check box to let sta members with this prole change the Honor External Suppression List
seing when creating or editing a survey.
 

Response Exclusion
 

Select this check box to let sta members with this prole exclude specic survey responses from
reports.
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Field Description

 

Questions
 

These options dene the question permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Questions section.
 

Read/Add/Edit
 

Select this check box to let sta members with this prole access questions, including the ability to add
and edit questions.
 

Delete
 

Select this check box to let sta members with this prole delete questions.
 

Thread
 

These options determine if sta members can modify notes in surveys or documents.
 

Select All
 

Select this check box to select all check boxes in the Thread section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to a
survey or document.
 

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to a survey or document.
 

Documents
 

These options dene the document permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Documents section.
 

Read/Add/Edit/Delete
 

Select this check box to let sta members with this prole read, add, edit, and delete documents.
 

Approve
 

Select this check box to let sta members with this prole approve documents. If cleared, the Approved
check box cannot be selected by sta members when adding or editing documents.
 

Edit Approved
 

Select this check box to let sta members with this prole edit a document that has been approved. If
cleared, sta members cannot edit documents if the Approved check box has been selected.
 

HTML Design Mode
 

Select this check box to let sta members with this prole use the HTML editor in design mode. If
cleared, the Design tab does not display and sta members can edit only in source mode.
 

Content Library
 

These options dene the content library permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Content Library section.
 

Templates
 

Select this check box to let sta members with this prole view, add, edit, and delete templates.
 

Snippets
 

Select this check box to let sta members with this prole view, add, edit, and delete snippets.
 

File Aachments Select this check box to let sta members with this prole view, add, edit, and delete les.
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Field Description

   

Tracked Links
 

Select this check box to let sta members with this prole view, add, edit, and delete tracked links.
 

Audiences
 

These options dene the segment and contact list permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Audiences section.
 

Segments
 

Select this check box to let sta members with this prole add, edit, and delete segments.
 

Contact Lists
 

Select this check box to let sta members with this prole add, edit, and delete contact lists.
 

Assignment
 

Select this check box to select the check box in the Assignment section.
 

Appear in Menus
 

Select this check box to display sta accounts associated with this prole in the Assigned drop-down
menu when adding or editing surveys or documents.
 

Task Permissions  
You can use the tasks options to give sta members permission to add, edit, and delete tasks.

Field Description

Tasks
 

These options dene the task permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Tasks section.
 

Read
 

Select this check box to let sta members with this prole view tasks.
 

Add
 

Select this check box to let sta members with this prole add tasks.
 

Edit
 

Select this check box to let sta members with this prole edit existing tasks. If cleared, tasks are read-
only when opened and sta members cannot edit elds or assign tasks.
 

Delete
 

Select this check box to let sta members with this prole delete tasks.
 

Thread
 

These options determine if sta members can modify notes in tasks.
 

Select All
 

Select this check box to select all check boxes in the Thread section.
 

Edit/Delete Notes created by logged in
user
 

Select this check box to let sta members with this prole edit and delete notes they have added to a
task.
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Field Description

Edit/Delete Notes created by any user
 

Select this check box to let sta members with this prole edit and delete notes other sta members
have added to a task.
 

Custom Objects Permissions  
You must specify permissions for your sta members to read, delete, and perform other actions on custom object
records.

All deployed custom objects are listed on the Custom Objects tab of the Proles editor and are organized by the package
they are contained in. Similar permissions can be granted for each object, though the Notes permissions are available
only for objects with a notes eld. Permissions can also be specied when editing custom objects on the Object
Designer.

Note:  Custom objects must be enabled for this tab to appear. Contact your Oracle account manager.

Field Description

Custom Object Permissions
 

These options dene the permissions needed to work with records for custom objects.
 

Select All
 

Select this check box to select all check boxes on the Custom Objects tab.
 

Package Name
 

This column displays package names.
 

Object Name
 

This column displays custom object names.
 

Create
 

Select check boxes in this column to let sta members with this prole create records for the custom
object.
 

Read
 

Select check boxes in this column to let sta members with this prole read records for the custom
object.
 

Update
 

Select check boxes in this column to let sta members with this prole update records for the custom
object.
 

Delete
 

Select check boxes in this column to let sta members with this prole delete records for the custom
object.
 

Personal Notes
 

Select check boxes in this column to let sta members with this prole create, edit, and delete notes in
custom object records.
 
This check box displays only for custom objects that contain note elds.
 

All Notes
 

Select check boxes in this column to let sta members with this prole edit and delete any notes added
to custom object records, regardless of which sta member added the notes.
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Field Description

This check box displays only for custom objects that contain note elds.
 

Related Topics
• Custom Object Types

Analytics Permissions  
Options on the Analytics page determine the reports that sta members with this prole can access for each available
interface.

You also can assign access to the analytics features, such as creating custom reports and dashboards.

If you are unable to perform certain actions on a report or dashboard, the cause may be that you lack the Analytics
permissions needed to perform the actions.

Field Description

Analytics
 

These options dene the analytics permissions for sta members with this prole.
 

Select All
 

Select this check box to select all check boxes in the Analytics section.
 

Create/Edit Reports
 

Select this check box to let sta members with this prole create custom reports and edit custom
reports they have access to.
 
This permission is required to open the Reports explorer.
 

Customize Reports
 

Select this check box to let sta members with this prole customize a report after it has been
generated.
 
This permission is required to access Analyze options on the Reports explorer ribbon.
 

Create/Edit Public Reports
 

Select this check box to let sta members with this prole create and edit public reports and create
public folders on the Reports explorer.
 

Modify Inline Report Editing
 

Select this check box to let sta members with this prole create reports with inline editing. This
permission also lets sta members edit data inline on the Agent Browser UI.
 

Print/Export/Forward Reports
 

Select this check box to let sta members with this prole print, export, and forward reports.
 

Administrator
 

Select this check box to give sta members with this prole administrator all analytics permissions.
This permission is required to edit standard reports.
 
By selecting this check box, all other check boxes are automatically selected.
 

Reports
 

The options in this section let you select which reports sta members with this prole can run and edit.
 
Custom folders that do not contain reports do not display in the list of reports.
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Field Description

All
 

Select this check box to let sta members with this prole Open or Edit all folders.
 

Open
 

Select this check box to let sta members with this prole run the reports in each folder. You can
expand report folders to select individual reports.
 

Edit
 

Select this check box to let sta members with this prole edit the reports in each folder. You can
expand report folders to select individual reports.
 

Search
 

Select this option to search for a report. This feature is useful for nding a report and seing its
permissions.
 

Sta Accounts Editor  
Use the Sta Accounts editor to perform a variety of sta-management tasks.

The editor enables you to perform these tasks.

• Add sta members

• Assign sta members to proles

• Group sta members according to level, department, area of expertise, manager, or other categories that apply
to your organization

Note:  These grouping options help you route incidents and opportunities to the appropriate group
and to report on groups of sta members that share similar job duties or the same manager.

• Congure and manage sta-member passwords

Congure Sta-Member Passwords  
You can enhance your sta members’ password security by specifying options that can prevent repeated invalid login
aempts, set password length and character requirements, and expiration details.

Note:  You must congure sta member passwords before adding sta accounts.

Password conguration is an important part of security for your organization and for your application. To learn about
the tools you can use for password security, see Password Protection. Also see How You Recover Forgoen Passwords
and How You Secure Customer Passwords.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Password Conguration.

The Password Conguration editor opens on the content pane.
3. Enter eld information to congure password requirement seings.
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Field Description

Login Requirements
 

This section contains the option to establish a limit on invalid login aempts.
 

Number of Invalid Logins
 

Drag the slider to the number of failed login aempts you want to allow before the
system locks out the account. Alternately, enter the number you want in the eld to the
right of the slider. A value of 0 disables this function. The default value is 5.
 
Only administrators possessing the Groups/Accounts/Distribution Lists prole
permission can unlock a sta account. After a successful login, the invalid login count is
reset to 0.
 

Password Expiration
 

This section contains options to customize time periods that aect password expiration.
 
If the Password Expires check box is cleared for a particular sta account, it overrides
any password expirations dened in the password conguration seings.
 

Expiration Interval
 

Drag the slider to the number of days that passwords stay in eect. Alternately, enter
the number you want in the eld to the right of the slider. After adding a sta account or
updating the account password from the Sta Accounts editor or the Change Password
window, the expiration date value is reset. A value of 0 turns password expiration o.
The default value is 90.
 

Grace Period
 

Drag the slider to the number of days after the password expires in which sta members
can enter a new password and still be allowed to log in. Alternately, enter the number
you want in the eld to the right of the slider. After the grace period ends, sta
members’ accounts are locked, and you must reset the expiration date or the password.
The default value is 14.
 

Warning Period
 

Drag the slider to the number of days before the password expires in which sta
members will be alerted to the approaching expiration date. Alternately, enter the
number you want in the eld to the right of the slider. During the warning period, sta
members can log in normally and are notied of the number of days until the current
password expires. The default value is 7.
 

Password Requirements
 

This section contains options to customize the format of sta account passwords and
limit their reuse.
 

Password Length
 

Drag the slider to the minimum number of characters required for a sta account
password. Alternately, enter the number you want in the eld to the right of the slider.
The default value is 8.
 
Password length cannot exceed 20 characters.
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Field Description

Character Repetitions
 

Drag the slider to the maximum number of consecutive repeated characters permied
in a password. Alternately, enter the number you want in the eld to the right of the
slider. For example, if Character Repetitions is set to 2, then a password such as 11011011
would be allowed, but 1110000 would not be allowed. The default value is 2.
 

Character Occurrences
 

Drag the slider to the maximum number of times a character can be used in a password.
Alternately, enter the number you want in the eld to the right of the slider. For example,
 if Character Occurrences is set to 2, then a password such as 10123456 would be
allowed, but 10101234 would not be allowed. The default value is 2.
 

Lowercase Characters
 

Drag the slider to the minimum number of lowercase characters required in a password.
Alternately, enter the number you want in the eld to the right of the slider. The default
value is 1.
 

Uppercase Characters
 

Drag the slider to the minimum number of uppercase characters required in a password.
Alternately, enter the number you want in the eld to the right of the slider. The default
value is 1.
 

Special Characters
 

Drag the slider to the minimum number of special characters required in a password.
Alternately, enter the number you want in the eld to the right of the slider. The default
value is 1.
 

Numbers and Special Characters
 

Drag the slider to the minimum number of special characters, including numbers,
required in a password. Alternately, enter the number you want in the eld to the right of
the slider. The default value is 1.
 

Number of Previous Passwords
 

Drag the slider to the number of passwords that will be stored in memory for each
sta account. Alternately, enter the number you want in the eld to the right of the
slider. Sta members cannot use any of the currently stored passwords when changing
passwords. The default value is 10.
 

4. Click Save.

Add or Edit a Sta Account  
When you add a sta account, you dene the login information for the sta member and associate a prole with the
sta member.

The following items must be created or congured before creating sta accounts.

• Proles. See Proles.

• Password security options. See Congure Sta-Member Passwords and Password Protection.
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• Sta account custom elds (optional). If you use sta account custom elds, we recommend creating them
before creating sta accounts. See Custom Field Types.

When adding or editing a sta account, you can also dene a name for the sta member to display in Chat and a
signature for responding to incidents. The Sta Accounts editor is also where you enter the default country and
currency.

A sta member can send S/MIME (Secure Multipurpose Internet Mail Extensions) email using a signature, encryption, or
both. To send encrypted S/MIME email, the sta member must be issued a certicate that is then uploaded to the sta
account. Certicates can be obtained from an authorized certication authority and must contain the sta member’s
email address. To send signed S/MIME email, the Envelope From/Bounce Address of the outgoing email must be a
mailbox address (rather than an individual sta member email address) that includes a certicate and a private key. See
How SMIME Security Works.

Note:  You can only add 100,000 accounts and you cannot create a duplicate account with the same login
credentials.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and the double-click Sta Accounts by Group (or another Accounts report).

The report opens on the content pane, listing the accounts that have already been created.
By default, the standard Accounts reports (Sta Accounts by Group, Sta Accounts by Manager, and Sta
Accounts by Prole) display only active accounts and accounts that have been temporarily disabled. Accounts
that have been permanently disabled are not displayed. To change the accounts displayed, click Search and
select the accounts you want to view. When displayed on the report, temporarily disabled accounts are shown
in italic text and permanently disabled accounts are displayed in gray text.

3. Do one of the following:

◦ To add a sta account, click New.

◦ To edit a sta account, double-click the account on the report.

The Sta Accounts editor opens.
4. Enter eld information.

Field Description

Virtual Assistant Account
 

This read-only check box is selected if the sta account has been designated as the
virtual assistant. Only one sta account can represent the virtual assistant.
 
For this check box to display, your site must be integrated with Oracle RightNow Virtual
Assistant Cloud Service (Virtual Assistant).
 

Non-Contact Center Account
 

Select this check box to designate this user as a non-contact center account.
 
For this check box to display, non-contact center user accounts must be enabled.
Contact your Oracle account manager.
 

*User Name
 

Enter the sta member’s user name in this eld. Sta members enter their user name
on the Login window. User names are case sensitive.
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Field Description

*First Name
 

Enter the sta member’s rst name in this eld. The rst name and last name appear on
the Service Console when the sta member is logged in.
 

*Last Name
 

Enter the sta member’s last name in this eld. The rst name and last name appear on
the Service Console when the sta member is logged in.
 

Change Password
 

Click Change Password to open the Change Password window. Enter the sta member’s
login password in the New Password eld and enter the same password in the Conrm
New Password eld. Passwords are case sensitive and encrypted. Keep in mind, the
length of the hidden password in the text box does not indicate the length of the actual
password. Click OK.
 
Passwords can be changed by sta members as long as the SSO Login permission is
not enabled in the prole assigned to their sta account. If the SSO login permission is
enabled, password options on the Sta Account editor are unavailable.
 

Password Expires
 

Select this check box to automatically expire the password after the time period
specied in the password conguration.
 

Force Password Change
 

Select this check box to require sta members to change their password the rst time
they log in after you update this seing in their sta account.
 
This check box remains selected until the sta member changes the password. After the
password has been changed, the check box is automatically cleared.
 

Invalidate Password
 

Select this check box to invalidate the sta member’s password. Selecting this check box
also disables the Change Password buon.
 
Sta members without a valid password can reset their password from the Login Help
link on the Login window. The Invalidate Password check box remains selected until the
sta member resets the password. After the password has been reset, the check box is
automatically cleared.
 

*Display Name
 

Enter a name for the sta member to be displayed in email communications and to
customers during a chat session.
 

Phone Number
 

Enter the phone number of the sta member in this eld.
 

*Prole
 

Click the Search icon next to this eld to open the Proles window. Select the prole
you want to associate with this sta member and click OK.
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Field Description

*Group
 

Click the Search icon next to this eld to open the Account Groups window where you
assign the sta member to a group.
 

Disabled
 

Click this drop-down menu to dene whether the sta account is disabled. You can
choose from the following options.

◦ Not Disabled—Select this option to make the account available for assignment to
incidents and other types of records and to display the account in report lters.
This is the default option.

◦ Disabled from Assignment—Select this option to exclude the account from being
assigned to incidents and other types of records.

◦ Disabled from Assignment/Report Filters—Select this option to exclude the
account from being assigned to incidents and other types of records and from
appearing in report lters.

◦ Permanently Disabled—Select this option to permanently disable the account.
Accounts that are permanently disabled display in reports but cannot be re-
enabled. The user name of a permanently disabled account cannot be used for a
dierent sta account.

 
If an employee leaves your organization, we recommend disabling the employee’s sta
account instead of deleting it. When sta accounts are deleted, they no longer display
in reports and are not available for use in custom reports used to track sta account
actions.
 

Account Locked
 

Select this check box to temporarily lock the sta account. You might choose to do this
if, for example, a sta member takes a leave of absence. This check box is also selected
automatically if a sta member has exceeded the number of invalid logins. Clear the
check box to unlock the sta account.
 

*Default Currency
 

Click this drop-down menu to select the currency you want to associate with the sta
account. The United States dollar (USD) is the only currency option in this menu until
you add others through the Currencies editor.
 

Time Zone
 

Click this drop-down menu to select the account time zone.
 
This drop-down menu is unavailable for accounts with any of the following permissions
selected for their prole: Administration, Incident Add/Edit, Incident Send Response,
Incident Delete, or SLA - Add/Disable/Delete.
 
If you wish to change the time zone associated with this sta member’s location, contact
your Oracle account manager to have the option enabled. (Note that the option should
not be enabled if you are using SLAs.)
 

*Default Country
 

Click this drop-down menu to select the country associated with this sta member.
 

Territory
 

Click this drop-down menu to select the sales territory associated with this sta
member.
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Field Description

 

External Screen Pop Port
 

Enter the port number that the system will listen on for external screen pop requests.
 
This eld displays only if the conguration seing EXT_CONSOLE_WS_ENABLED is
enabled on the Conguration Seings editor.
 
The EXT_CONSOLE_WS_PORT conguration seing denes the port value for all sta
members. However, if a value is specied in the External Screen Pop Port eld, that
value overrides the value specied in EXT_CONSOLE_WS_PORT.
 

Email Address
 

Enter the sta member’s email address. This is required to receive scheduled reports
and system notications.
 

Email Notications
 

Click this drop-down menu to select the email notications the sta member receives
when an event occurs, such as an incident being assigned. The following options are
available.
 
No Notications—Select this option to prevent email notications from being sent to
the sta member.
 
Short Notication Once—Select this option to send a brief email notication when an
event occurs and the sta member is not logged in. Subsequent events do not trigger
additional notications until the sta member logs in and logs out again.
 
Detailed Notication Once—Select this option to send a detailed email notication
when an event occurs and the sta member is not logged in. Subsequent events do not
trigger additional notications until the sta member logs in and logs out again.
 
Detailed Notication Always—Select this option to send a detailed email notication
for every event that triggers a notication, not just the rst one. When this option is
selected, the sta member receives email even when logged in.
 

Email Signature
 

Enter a signature for the sta account to be appended to incident responses.
 

User Can Customize
 

Select this check box to let the sta member customize the email signature. When sta
members who have this permission access options from the le menu ( File > Options >
Personal Seings ), they can enter their own signature in the Email Signature eld.
 

S/MIME Account Certicate
 

Click the Folder icon to locate the le containing the public S/MIME account certicate.
The certicate must contain the email address of the sta account.
 
S/MIME security options are not available for Outreach mailboxes.
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Field Description

Import untrusted certicates
 

Select this check box to bypass verication that the certicate le being imported
or a contact certicate extracted from a signed S/MIME email is signed by a trusted
certication authority. The Techmail utility will then import public certicates from S/
MIME emails sent to this sta account that are not signed by a trusted certication
authority.
 
Changing this seing does not aect previously imported and stored certicates.
 

Import expired or not yet valid
certicates
 

Select this check box to bypass verication of the certicate date for the certicate
le being imported or a contact certicate extracted from a signed S/MIME email.
The Techmail utility will then accept certicates from S/MIME emails sent to this sta
account that have expired or are not yet valid. This seing applies to every certicate in
the certicate chain, from the root certicate through any subordinate certicates to the
POP3 server certicate.
 
Changing this seing does not aect previously imported and stored certicates.
 

5. To assign the sta account to a manager, click Department. See Organize Sta Members by Manager.
The Department editor can also be used to assign sta accounts to groups. In addition, the page displays other
sta members assigned to the same group and manager.

6. To dene custom eld information, click Custom Fields.
The Custom Fields editor opens. Any sta account custom elds created in your application will display.

7. To enter channel information, click Channels. See the procedure described in Social Channels for more
information.

8. To view a log of changes that have been made to the sta account, click Audit Log.
9. Click Save.

Related Topics
• Proles

• Considerations When Using Single Sign-on

• How You Customize Conguration Seings

• Congure Sta-Member Passwords

• Change Your Personal Seings

• Creating a Sta Account (video)

Assign a Sta Account to a Group  
Every sta account you create must be assigned to a group.

When deciding how to group your sta members, you should plan how you want them organized for reporting. For
example, groups can be based on a specialty area of agents or the region of sales representatives.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Sta Accounts by Group (or another Accounts report).
3. Double-click the sta account you want to assign to the group.
4. Do one of the following:
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◦ Click the Search icon next to the account Group eld.

◦ Click the Department tab on the ribbon and click the Search icon next to the Group eld.

The Account Groups window opens.
5. To assign the account to an existing group, select the appropriate group.

Sta members with the Proles permission enabled on the Administration tab can change group assignments
by dragging sta accounts from the open report to the Group folders on the left side of the report.

6. To assign the account to a new group, click New Group and enter a name for the group.
7. To change the display order of the groups, select the group you want to move and click the up or down arrow.
8. To rename a group or add a description to a group, right-click the group and select Edit. The Edit Group

window opens.
a. Enter the name you want for the group in the Label eld.
b. Enter notes or other information you want regarding the group folder in the Description eld.
c. Click OK.

9. To delete a group, right-click the group, select Delete, and click OK to conrm the deletion message.
You can delete only those groups that do not have associated sta accounts.

10. Click OK to close the Account Groups window.
11. Click the Save to save the changes to the sta account and group.

Sort the Sta Accounts in a Group  
You can change the ordering of groups displayed in group lists or of sta accounts displayed in groups, such as in
report lters.

1. Open a sta account in the group you want to sort.
2. Click Department on the ribbon.

All sta members in the account’s group display in the Sta in Group list. See Organize Sta Members by
Manager for information about the Departments editor.

3. Click Sort above the Sta in Group list. The Sort Sta in Group window opens.
a. Select the option next to the sort option you want to use.

- Sort by First Name, Last Name—Select this option to sort the accounts in the group by rst
name, starting with rst names beginning with A.

- Sort by First Name, Last Name (reversed)—Select this option to sort the accounts in the group
by rst name, starting with rst names beginning with Z.

- Sort by Last Name, First Name—Select this option to sort the accounts in the group by last name,
starting with last names beginning with A.

- Sort by Last Name, First Name (reversed)—Select this option to sort the accounts in the group
by last name, starting with last names beginning with Z.

b. Click OK.
4. To customize the sort order, select an account you want to move in the Sta in Group list and click the up or

down arrow.
5. Click Save.

Organize Sta Members by Manager  
You can organize sta members in a manager hierarchy, listed beneath their managers or team leads.

You create the manager hierarchy, which is used in Opportunity Tracking, and can also be used to help you beer report
on the performance of managers and their sta. You can create up to twelve levels of accounts in the hierarchy.

92



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Tip:  You can also view accounts in the manager hierarchy using the standard Sta Accounts by Manager
report (Public Reports/Common/Site Administration/Sta Management).

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Sta Accounts by Group (or another Accounts report).
3. Double-click the account you want to assign to a manager.
4. Click Department on the ribbon.

The Departments editor opens where you can specify the account group and manager hierarchy. You can also
view lists displaying the other sta members in the same group and the manager hierarchy.

Note:  Sta groups can be managed on the Department page. See Assign a Sta Account to a Group
for information about creating and editing groups and adding and ordering sta accounts in groups.
Sta members with the Proles permission on the Administration tab can change group assignments
by dragging sta accounts from the open report to the Group folders on the left side of the report.

5. Click the Search icon next to the Manager eld.
The Account Manager Hierarchy window opens.

6. Select the manager you want to assign the account to.
7. Click OK.
8. Click Save.

Delete a Sta Account  
Sta accounts can be deleted like other types of records in Oracle Service Cloud. However, it is important that you
understand what happens when you delete a sta account.

Sta accounts that are deleted are completely removed from your site. They no longer display in reports and are no
longer available for use in custom reports you use to track the actions of sta accounts. For this reason, when an
employee leaves your organization, we recommend disabling the account instead of deleting it.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Sta Accounts by Group (or another Accounts report).
3. Select the sta account you want to delete.
4. Click Delete.

A message asks you to conrm the deletion.
5. Click Yes to delete the sta account.

Customizable Menus  

Overview of Customizable Menus  
Customizable menus help you develop logical, consistent ways to organize objects such as contacts, incidents, tracked
links, and sales products in ways that are most useful to your organization.

When you customize drop-down menus, you increase the likelihood of an organized, accurate, and up-to-date
knowledge base, which is essential for providing an exceptional customer experience. The available customizable
menu items on your navigation pane depend on the Oracle Service Cloud products that are enabled on your site, your
navigation set, and your prole permissions.
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Keeping your knowledge base organized and up-to-date is an important way to provide superior customer service.
When you create custom drop-down menus with the exact options you need, sta members can classify incidents and
answers using those options, and customers can select specic products and categories for community posts and to
rene their searches for answers. Both customers and sta members benet from the exibility that results when you
classify incidents and answers in ways that make the most sense for your organization.

Note:  The Customizable Menus tree contains a System Menus folder, containing default menu items, and
a Custom Menus folder, which you can use to create menu items for menu-only custom objects. If custom
objects is not enabled on your site, the tree will not contain any folders and only the default menu items will
be listed in the tree. Contact your Oracle account manager to enable custom objects. See Add a Custom Object
Menu Item.

Select a customizable menu item to learn how to add and edit it.

Menu Item(s) Action

Answer access levels
 

Add custom answer access levels for increased control over the information that is visible to sta
members and customers.
 

Answer statuses
 

Add custom answer statuses for increased classication of answers in the knowledge base.
 

Asset statuses
 

Add custom asset statuses for tracking which assets are in use, which are no longer used or supported,
 and which assets have not been associated with customers.
 

Billable tasks
 

Dene billable tasks for classifying and recording how agents spend their time working on incidents.
 

Channel types
 

Add channel types for contacts so they can associate their Twier, YouTube, and Facebook user names
through the customer portal.
 

Chat agent statuses
 

Add custom statuses to describe an agent’s availability to chat with customers and assist other agents
with their chat sessions.
 

Chat session queues
 

Identify queues that can be used for routing chat session requests.
 

Competitors
 

Add competitors to your knowledge base to help your organization track won and lost opportunities by
competitor.
 

Contact roles
 

Add contact roles to classify the role of contacts in opportunities. Contact roles allow sta members to
identify the same contact by dierent roles in dierent opportunities.
 

Contact types
 

Add contact types to help you organize contacts in ways that are most useful to your organization.
 

Countries
 

Maintain accurate, consistent address data for contacts and organizations by adding the countries and
provinces your organization does business in.
 

Custom object menus  and Edit a Custom
Object Menu Item
 

Use custom object menus to add, copy, and delete custom object menu items.
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Menu Item(s) Action

Incident queues
 

Identify queues that can be used for routing incidents automatically or manually based on the criteria
you establish.
 

Incident severities
 

Dene incident severity levels for classifying incidents.
 

Incident statuses
 

Add custom incident statuses to track the state of an incident.
 

Industry types
 

Use industry types to identify those your customers are associated with.
 

Lead rejection types
 

Use lead rejection types to identify reasons for rejecting prequalied opportunities.
 

Opportunity statuses
 

Use opportunity statuses to identify the current state of opportunities in the knowledge base.
 

Organization address types
 

Add organization address types when you need more exibility than that oered by the standard
billing and shipping addresses.
 

Price schedules
 

Establish various pricing schedules that can be applied to sales products.
 

Product catalog  and Add a Price Schedule
to a Sales Product
 

Use the product catalog to add, edit, and categorize sales products and assign price schedules to them.
 

Products/categories/dispositions
 

Add products and categories for grouping incidents and answers, resulting in more accurate search
results for sta members and customers. Use dispositions as a way to record the nal resolution of a
solved incident.
 

Product linking
 

Link products to categories and dispositions so menus display only the links that are relevant to the
selected product. This feature ensures more accurate data recording and simplied searching for
incidents and answers.
 

Tracked link categories
 

Assign tracked links to categories, and enhance reporting on customer clicks of links in your mailings
and surveys.
 

Win/loss reasons
 

Identify win/loss reasons to determine what contributes to the outcome of opportunities.
 

Add or Edit a Country or Province  
Adding countries and provinces to the knowledge base helps maintain accurate address information.

Because the countries and provinces appear in drop-down menus when sta members enter contact and organization
information, consistent names and abbreviations for unfamiliar countries are guaranteed. You can also dene format
masks to require that sta members use the same format when entering phone numbers and postal codes.

The United States is automatically included, and you can add any other country where you have contacts and
organizations. Provinces cannot be added independently, but must be associated with the appropriate country. You can
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add them when you add the country or at a later time when you edit the country. When sta members enter an address
and select a country, the State/Prov eld contains a drop-down menu of the states or provinces associated with that
country.

You can also delete countries and provinces on the Countries editor by clicking Delete. When you delete a country or
province, any contacts and organizations that were associated with that country or province no longer have a country or
province association.

1. Click Conguration on the navigation pane.
2. Expand Internationalization, and then double-click Countries.

The Countries tree displays on the content pane.
3. Do one of the following:

◦ To add a country, click New to display the editor.

◦ To edit a country, click it in the tree.

4. Enter eld information.

Field Description

*Name Select a country from the Country/ISO Code list at the top of the editor or enter the
name of the country in the eld.

*Abbreviation When you select a country from the list on the editor, the Abbreviation eld is populated
with the 2- or 3-digit abbreviation the country uses. This may or may not be the same as
the ISO code for the country, which appears in parentheses after the name in the list of
countries.
If you entered a country name instead of selecting one from the list, the country does
not have an ISO code. As a result, the Locate Address buon next to the Address eld on
a contact, organization, or incident is disabled.
 

Phone Mask Enter a mask to restrict what sta members can enter in the phone number eld.

Phone Code Enter the international phone code for the country.

Postal Mask Enter a mask that restricts what sta members can enter when they enter postal codes
for contacts in this country.

5. To add a province, click Add (in the Provinces section on the right side of the editor), and then enter the
province name in the Name eld.

6. To edit the name of a province associated with the country you are editing, select the province name and enter
the new name.
You can move provinces within the list using the up and down arrows next to the Provinces list.

7. Click Save.

Related Topics
• Input Masks
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Add or Edit an Organization Address Type  
Organization address types let you maintain multiple addresses for the organizations in the knowledge base.

The default address types are Billing and Shipping. When your organization needs other address types, you can add
as many as you need. For example, you might nd it useful to have an international address type or a headquarters
address type. You can delete any address type except Billing by selecting it and clicking Delete.

CAUTION:  When you delete an organization address type that has been used in an organization record, this
action deletes all address data previously associated with that address type.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Click the arrow next to the System Menus folder to expand the list.
4. Select Organization Address Types to display the editor.
5. Do one of the following:

◦ To add an address type, click New.

◦ To add a new address type directly under an existing address type in the tree, select the existing address
type and click New.

◦ To edit an address type, click it in the tree.

6. Enter a name for a new address type or edit an existing name in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click Save.

Add or Edit a Contact Type  
Using contact types, you can organize the contacts in your knowledge base into classications that are important to
your organization.

When sta members add or edit contacts, they can select the contact type from the menu options you add. You might
want to add contact types that reect the position of a contact, such as manager, buyer, agent, and assistant. Or you
could add contact types that reect a contact’s function with respect to your organization, such as technical expert,
decision maker, and reference.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder to view the list.
4. Click Contact Types to display the editor.
5. Do one of the following:

◦ To add a contact type, click New.

◦ To add a new contact type directly below an existing contact type in the tree, select the existing contact
type and click New.
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◦ To edit a contact type, click it in the tree.

6. Enter a name for a new contact type or edit an existing name under the Label column.
The corresponding eld under the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click Save.

Add or Edit a Price Schedule  
Multiple price schedules provide greater exibility for pricing sales products.

You may price a sales product dierently for preferred customers, or you may have various price schedules for
customers in dierent countries.

Because products in the product catalog can have an associated price schedule, you should add price schedules before
you add sales products.

Note:  The Delete option is not available for price schedules that are associated with sales products. If you
want to delete a price schedule associated with a sales product, rst edit the sales product to remove the price
schedule association.

1. Click Conguration on the navigation pane.
2. Expand Sales in the conguration list, and then double-click Price Schedules.

The Price Schedules tree displays on the content pane.
3. Do one of the following:

◦ To add a price schedule, click New to display the editor.

◦ To edit a price schedule, click it in the tree.

4. Enter eld information.

Field Description

*Price Schedule Name Enter the name of the price schedule. The item name in the Price Schedules tree on the
left side of the content pane and the corresponding eld under the Label column in the
Interface Visibility section are populated or revised as you type.

Disabled Select this check box to prevent the price schedule from appearing in the Price Schedule
drop-down menu when selecting a price schedule for a sales product.

*Currency Click this drop-down menu and select a currency. Currency options are added to the
Currencies/Exchange Rates editor.

Notes Enter any notes you want to add to the price schedule.

Interface Visibility Clear the check box if you do not want the sales product to be visible on the interface.

5. Click Save.

Related Topics
• Add or Edit a Currency
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Add or Edit a Sales Product  
When you add sales products, you dene the product catalog used to create quotes and Oer Advisor promotions and
suggestions.

You also add sales products to use as customer assets.

You can enable or disable sales products, establish visibility, add identication elds, enter product descriptions,
associate price schedules, associate a service product, and enter custom eld values. Since sales products can be
associated with price schedules and service products, you should add price schedules and service products rst.

Note:  If you try to delete a sales product that is used in an Oer Advisor promotion by selecting it in the tree
and clicking Delete, a dependency conict window opens and noties you that deletion is not allowed.

1. Click Conguration on the navigation pane.
2. Expand Sales in the conguration list, and then double-click Product Catalog.

The Product Catalog tree displays on the content pane.
3. Do one of the following:

◦ To add a sales product, click New to open the Product Details editor.

◦ To edit a sales product, click it in the tree.

4. Enter eld information.

Field Description

*Product Name
 

Enter the sales product name. The item name in the Product Catalog tree on the
left side of the content pane and the corresponding eld in the Label column in the
Interface Visibility section are populated or revised as you type.
 

ID
 

Enter an identier for the sales product in this eld. This can be a catalog number,
 product name, or any other identier your organization wants to use.
 

Suggestion Exclude
 

Select this check box to exclude the sales product from being automatically suggested
to a customer through Oer Advisor. If cleared, the product is eligible for suggestion to
customers who match Oer Advisor purchase history data.
 

Disabled
 

Select this check box to prevent the sales product from displaying when creating a
quote, promotion, or customer asset or from being available as a suggested product in
Oer Advisor.
 

Sales Catalog
 

Select this check box to make the sales product available for use in Opportunity Tracking
and Oer Advisor. If cleared, or if the Disabled check box is selected, the sales product
will not be available in Opportunity Tracking or Oer Advisor.
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Field Description

Service Catalog
 

Select this check box to make the sales product available for use in Oracle RightNow
Cloud Service (Service). If cleared, or if the Disabled check box is selected, the sales
product will not be available in Service.
 

Serialized
 

Select this check box to prompt customers and agents to enter a serial number when
using this sales product as a customer asset.
 

Service Product
 

Click this drop-down menu to associate a service product with the sales product.
 

Description
 

Enter a description of the sales product that can be viewed by sales reps when they add
products to quotes.
 

Price Schedules
 

Select one or more price schedules.
 

Interface Visibility
 

Clear the check box if you do not want the sales product to display when sta members
add products to quotes while creating or editing an opportunity.
 
The sales product will remain on the Promotions editor.
 

5. To add information for any sales products custom elds, click Custom Fields and enter the information.
Depending on the type of eld, you can enter text in a eld, select a date from a drop-down calendar, select a
menu option, or select an option.

6. Click Save.

Related Topics
• Search Optimization Using Products, Categories, and Dispositions

• Overview of Oer Advisor

• Overview of Oer Advisor Administration

• How You Manage Quotes

• Custom Field Types

• Add or Edit a Sales Product to Use with Assets

Add a Price Schedule to a Sales Product  
Price schedules provide an additional method for classifying information about sales products, but their use is optional.

If you do not create price schedules or add them to sales products, the sales products are not available to sta members
creating quotes. Only those products associated with the selected price schedule can be used in a quote.

1. Click Conguration on the navigation pane.
2. Expand Sales in the conguration list, and then double-click Product Catalog.
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The Product Catalog tree displays on the content pane.
3. Click a product in the tree to open the Product Details editor.
4. Click New to the right of Price Schedules.

A row is added to the table.
5. Click the Price Schedule drop-down menu and select a price schedule.
6. Enter eld information.

Field Description

*Price Double-click this eld and enter a price.

Currency This read-only eld is determined by the price schedule you select.

*Start Date Click each month, day, and year component of this date eld and enter an eective start
date for the price schedule. Or click the calendar and select a date.
When you add a price schedule, this eld is populated with the current date.
 

End Date This read-only eld is blank if you select only one price schedule for the sales product.
However, if you add the same price schedule with a dierent price, the start date for
the later-starting price schedule becomes the end date for the earlier-starting price
schedule.

Notes Enter any notes you want to add to the price schedule.

7. Click Save.

Related Topics
• How You Manage Quotes

Add a Custom Object Menu Item  
After menu-only custom objects are created and deployed, you can add them in Customizable Menus.

You add custom object menu items through the Custom Object Menu editor.

1. Click Conguration on the navigation pane.
2. Expand  Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the Custom Menus folder.
4. Select a custom menu item in the tree.

The Custom Object Menu editor opens on the content pane.
5. Click New.

The new menu item is added to the Custom Object Menu editor.
6. Enter a name for the menu item.
7. Click Save.

101



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Edit a Custom Object Menu Item  
After menu-only custom objects are created and deployed, you can copy, edit and delete them in Customizable Menus.

You edit, copy and delete custom object menu items through the Custom Object Menu editor.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the Custom Menus folder to view the list.
4. Select a custom menu item in the tree.

The Custom Objects Menu editor displays on the content pane.
5. To change the display sequence of a menu item, select it in the tree and click the up or down arrow next to the

Label column.
6. To rename a menu item, select it on the editor and enter the new name.
7. To copy a menu item, select it on the editor and click Copy.
8. To delete a menu item, select it on the editor and click Delete.

How You Organize Information with Products, Categories, and
Dispositions  
When you use products and categories to group incidents and answers, your knowledge base is more organized. As a
result, sta members and customers can quickly nd answers to their questions.

For example, a company that manufactures and sells cellular phones might add products such as Smart Phones,
Camera Phones, and Accessories. Categories might include Technical Specications and Warranty Information.

Products and categories organize data in the same ways, and you can choose to use either or both when you congure
Service. If you use both, incidents and answers can be organized into specic classications, and customers can
search for answers using product and category lters. Customers can select specic products and categories to rene
community posts and searches. You can create up to six levels each of products and categories and specify the number
of levels agents must enter when working with incidents. Although products and categories are powerful options for
keeping the knowledge base well organized, you are not required to use them.

An incident’s disposition refers to the way the incident is ultimately solved. You may want to require that agents select
a disposition before they save an incident when they change the status to Solved. Dispositions do not appear on the
customer portal.

Incident dispositions can provide important information and insight about your organization’s interactions with
customers. You can add as many dispositions as you need, and you can also add sub-levels of dispositions to a total of
six levels. For example, you might have a top-level disposition of Sent to Regional Billing. With additional levels, you can
organize incidents into specic sub-dispositions such as East Coast, Midwest, Rocky Mountain, and Pacic Northwest.
Service lets you dene the number of disposition levels agents must select before marking an incident solved.

Perform these tasks to congure product, categories, and dispositions.

• Dene levels of products, categories, and dispositions on the administration interface—Set the number of
product, category, and disposition levels you want to require on the administration interface.
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• Dene levels of products and categories on the customer portal—Set the number of product and category
levels you want to require customers to select on the Ask a Question and community pages.

• Add products, categories, and dispositions—Add the products and categories you want to use for grouping
answers and incidents in the knowledge base. The products and categories you add appear to sta members
who work with answers and incidents on the content pane. They also appear on the customer portal for
customers to use when searching for and subscribing to answers and using the community. Add dispositions so
agents can indicate how an incident was ultimately resolved.

• Link products to categories—To restrict category selections to only the categories associated with a selected
product, enable and congure product-category linking. Product-category linking aects sta members
working with incidents and customers searching on the customer portal.

• Link products to dispositions—To restrict sta member selection of dispositions based on the incident’s
product, enable and congure product-disposition linking.

Related Topics
• Product Linking

Specify the Number of Required Product Levels for Incidents  
You can use up to six levels of products, categories, and dispositions to classify incidents and answers in the knowledge
base.

By creating subproducts, for example, you can let your customers further rene their searches. This also lets sta
members classify incidents and answers more precisely. If you have created multiple levels of products, categories, and
dispositions, you can also dene the number of levels that sta members are required to select on the administration
interface.

Note:  Although this procedure describes how to congure the number of product levels on an incident
workspace, follow these same steps to dene the Minimum Level value for the Category and Disposition elds.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces.

The Workspaces explorer displays on the content pane.
3. Right-click the custom incident workspace where you want to specify the number of product levels and select

Open.
You cannot edit the standard incident workspace, but you can copy it and edit the copied workspace.

4. Select the Product eld on the design space.
5. Click Minimum Level on the ribbon’s Design tab and enter the number of required product levels.

Allowed values range from 0 to 6.
6. Click the Save icon on the Quick Access Toolbar.
7. Assign this workspace to the applicable prole. See Proles if you need help with this process.

Search Optimization Using Products, Categories, and Dispositions  
Customers can use products and categories to narrow their search results on the customer portal.

Because the search results are ltered on the customer portal through these classications, the search nds answers
and community entries that are more likely to resolve customers’ questions. Likewise, agents can search for incidents
and answers based on products and categories when responding to incidents. They can also classify incidents and
answers when they work on them by selecting products and categories, thereby increasing the organization of
information within the knowledge base.
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Note:  For Knowledge Advanced customers, the lists of products and categories available to content authors
depend on how items are congured in Knowledge Advanced. See Managing Products and Categories for
more information.

Before you add products and categories, take some time to plan how you want use them to organize incidents and
answers. For example, if you have many products that share a common set of support issues, you might want to add a
top-level product name to group them instead of using individual product names. Or you might want to add subproduct
levels to further lter the products. Top-level products and categories classify incidents and answers in broad groupings,
but you can add ve more levels of subproducts and subcategories to further rene classication.

When agents classify incidents according to their disposition, your knowledge base contains the information you
need to understand how incidents have been closed. Additional levels of subdispositions let you further rene the
classication of incidents.

The following procedures describe working with products, but the procedures to add and edit categories and
dispositions are identical. Simply replace product information with category or disposition information where
appropriate.

• Add or Edit a Product

• Add a Subproduct

• Edit Visibility Seings for Multiple Products Simultaneously

Add or Edit a Product  
Add or edit a product to narrow customer search results on the customer portal.

The following procedure describes working with products, but the procedures to add and edit categories and
dispositions are identical. Simply replace product information with category or disposition information where
appropriate.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.

The content pane displays separate columns for products, categories, and dispositions.

Note:  By default, the editor displays all three columns, indicated by the highlighted Products,
Categories, and Dispositions buons in the Show group on the ribbon. To hide one or more columns,
click the associated buon so that it is no longer active. The column is removed from the editor until
you click the buon again or until you close and reopen the editor.

3. Do one of the following:

◦ To add a product, click in the Products column and click New. The New Product window opens.

◦ To edit a product, right-click it and select Edit.

Tip:  To add a product at the same level as a selected product, right-click the product and select Add
Sibling. To add a subproduct, right-click and select Add Child.

4. Enter the name of the product in the Name eld.
The word you enter in the Name eld is a keyword for all answers associated with this product. When customers
search by the product name, all answers associated with this product are returned.

5. To make the product visible to sta members working with incidents, select Administration.
Regardless of interface or visibility seings, all service products and categories are visible when adding or
editing answers on any interface.
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6. To make the product visible to customers on the customer portal, select End-user. (The End-user check box is
not available when adding or editing dispositions.)
Selecting the visibility seings for a parent level does not automatically set the same seings for the parent
sublevels. Visibility must be set individually for each. You can also make subproducts visible even if the parent
product is not visible.

Note:  For Knowledge Advanced customers, visibility of products and categories depend on how items
are congured in Knowledge Advanced. See Managing Products and Categories for more information.

7. To enter a description for the product, click Description and enter it in the Description eld.
8. Click Save.

The product appears in the Products column.

Add a Subproduct  
Add a subproduct to narrow customer search results on the customer portal.

The following procedure describes working with products, but the procedures to add and edit categories and
dispositions are identical. Simply replace product information with category or disposition information where
appropriate.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.

The content pane displays separate columns for products, categories, and dispositions.

Note:  By default, the editor displays all three columns, indicated by the highlighted Products,
Categories, and Dispositions buons in the Show group on the ribbon. To hide one or more columns,
click the associated buon so that it is no longer active. The column is removed from the editor until
you click the buon again or until you close and reopen the editor.

3. Do one of the following:

◦ Right-click the product you want to add the subproduct to and select Add Child.

◦ Select the product you want to add the subproduct to and click  New > Child  on the ribbon.

The New Product window opens.
4. Enter the name of the subproduct in the Name eld.
5. To enter information about the subproduct, click Description and enter it in the Description eld.
6. Select each visibility check box where you want the subproduct to appear.
7. Click Save.

The subproduct appears below the product you added it to.

Note:  You can also dene a subordinate relationship by dragging one product and dropping it onto
another product. See Change the Order of a Product, Category, or Disposition.

Edit Visibility Seings for Multiple Products Simultaneously  
Edit product visibility for sta members and customers for multiple products simultaneously.

The following procedure describes working with products, but the procedures to edit categories and dispositions are
identical. Simply replace product information with category or disposition information where appropriate.

1. In the Products column, press Ctrl while selecting each product.
2. Click Edit.

A multi-edit window opens.
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3. Select Visibility.
4. To make the products visible to sta members working with incidents, select the Administration check box.

Regardless of interface or visibility seings, all service products and categories are visible when adding or
editing answers on any interface.

5. To make the products visible to customers on the Customer Portal, select the End-user check box.
The End-user check box is not available when editing the visibility of dispositions.

6. Click Save.

Change the Order of a Product, Category, or Disposition  
You can reorder products, categories, and dispositions as necessary, including creating subordinate relationships.

You cannot move an item when another item of the same type is open on the editor. For example, if you are editing a
product, you cannot move any other product until you close the product editor.

The following procedure describes working with products, but the procedures to reorder categories and dispositions are
identical. Simply replace product information with category or disposition information where appropriate.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.

The content pane displays separate columns for products, categories, and dispositions.
3. Select the product you want to move and hold down the mouse buon or other pointing device.
4. Drag it to its new position in the Products column. If you want to make the product a subproduct of another

product, drag it onto the other product.
5. Release the mouse buon.

What Happens When You Delete Products, Categories, and Dispositions  
You can delete products, categories, and dispositions that do not have sublevels.

When deleting a product or other item that has sublevels, you must delete all of the sublevels rst. You also cannot
delete multiple products, categories, or dispositions simultaneously.

You do not receive a dependency conict warning when you delete products, categories, or dispositions used in rules.
Rules that use the deleted item may no longer function as expected, requiring you to edit the rules and reactivate the
rule base. See Add a Rule.

In addition, you do not receive a dependency conict warning when deleting products or categories that are used in
answers. Answers that are associated with deleted products or categories may not display as expected. We recommend
viewing the Answers by Category and Answers by Product reports before deleting products or categories that may be
associated with answers.

Delete a Product That Has Subproducts  
When deleting a product or other item that has sublevels, you must delete all of the sublevels rst.

The following procedure describes working with products, but the procedures to delete categories and dispositions with
sublevels are identical. Simply replace product information with category or disposition information where appropriate.

Note:  You do not receive a dependency conict warning when you delete products, categories, or dispositions
used in rules. Rules that use the deleted item may no longer function as expected, requiring you to edit the
rules and reactivate the rule base. See Add a Rule. In addition, you do not receive a dependency conict
warning when deleting products or categories that are used in answers. Answers that are associated with
deleted products or categories may not display as expected. We recommend viewing the Answers by Category
and Answers by Product reports before deleting products or categories that may be associated with answers.
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1. Expand the highest product level to display all subproducts.
2. Do one of the following:

◦ Right-click each subproduct and select Delete.

◦ Click Delete on the ribbon.

A message asks you to conrm each deletion.
3. Repeat these steps until all subproducts have been deleted.

Product Linking  
If your organization has large numbers of categories or dispositions, sta members and customers must review long
lists of menu items to nd appropriate options. You can simplify their choices with product linking.

When products are linked to categories, only the linked categories are displayed when customers select products on
the customer portal or when sta members select products while working on incidents. When products are linked to
dispositions, only the linked dispositions are displayed when agents select products for incidents. Product linking is a
powerful tool for enhancing eciency for both sta members and customers.

Note:  When product links have not been dened or product linking has been disabled, all categories and
dispositions are available, regardless of the selected product. Product-category linking is independent of
product-disposition linking, so you can enable one or the other or both.

Leaf products are those products that do not have any subproducts. Similarly, leaf levels of categories have no
subcategories and leaf-level dispositions have no subdispositions. Links can be created only between leaf levels of
products and categories and between leaf levels of products and dispositions. However, implicit linking occurs between
the parent levels of products, categories, and dispositions that are linked. Parent products implicitly contain the same
links that the leaf products below them contain. In other words, a parent product’s links are “inherited” from their leaf
products.

Assume, for example, you want to link a leaf-level product called Prepay to categories, and the Prepay product is a
subproduct of Call Plans. Also assume that none of the other leaf products under Call Plans have category links.

When you edit the Prepay product and select Category Links, assume you select the General category, which creates
two links, one to each of its leaf categories: Information and Help. Also assume you select Account and Billing, which is a
leaf category (no subcategories).

When you save your links, return to the Products/Categories/Dispositions editor, and drill down on the Category-Links
report, you see the three categories you just linked to the Prepay product. For example,

Account and Billing
General > Help
General > Information

Although you linked the leaf product, Prepay, to the categories, its parent product (Call Plans) was implicitly linked to the
same categories. So even though you cannot directly link a parent product to categories, you implicitly link it by linking
one or more of its leaf products.
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How You Link Products, Categories, and Dispositions  
Service can automatically create links to categories and dispositions based on answers and incidents in the knowledge
base, or you can manually dene the links for each product.

When you manually link products, you can select and link products one at a time or you can select multiple products to
link in one operation.

Note:  The greater the number of products, categories, and dispositions your organization uses, the more
exibility product linking can oer. However, this requires you to carefully consider how you link products to
categories and dispositions. If you create too many links, you risk losing the eciency product linking oers. If
you create too few, you may prevent customers and sta members from selecting the appropriate category or
disposition.

Use the following procedures to link products with categories and dispositions.

• Create Links Automatically

• Create Links for One Product at a Time

• Create or Remove Links for Multiple Products Simultaneously

• Link Categories to Products

• Link Dispositions to Products

Create Links Automatically  
Create product-category and product-disposition links automatically.

CAUTION:  This action replaces all product-category and product-disposition links (including any you have
created manually) with the automatically created links. Carefully review this procedure before creating links
automatically.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.

The top levels of products, categories, and dispositions are listed in columns on the editor.
3. To create product-category links automatically, click Auto-Build and select Product-Category Links.

A message opens to tell you that you cannot use the editor during the linking process and that all existing
product-category links will be deleted.

4. Click Yes to continue.
This schedules the automatic linking process for the next time Dbstatus runs (which happens every fteen
minutes). The editor is inactive until the Auto-Build process is complete, so you cannot edit products,
categories, or dispositions during that time.
A link is created for every product-category combination of leaf products and leaf categories associated to
answers in the knowledge base. In other words, in any given answer, every leaf product associated with the
answer is linked to every leaf category associated with the answer.

5. To create product-disposition links automatically, click Auto-Build and select Product-Disposition Links.
A message opens to tell you that you cannot use the editor during the linking process and that all existing
product-disposition links will be deleted.

6. Click Yes to continue.
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This schedules the automatic linking process for the next time Dbstatus runs (which happens every fteen
minutes). The editor is inactive until the Auto-Build process is complete, so you cannot edit products,
categories, or dispositions during that time.

A link is created for every product-disposition combination of leaf products and leaf dispositions associated to
incidents in the knowledge base that were created within the last thirty days. In other words, every leaf product
associated with an incident is linked to every leaf disposition associated with the incident.

To edit the automatically generated list of product links, see Create Links for One Product at a Time and Create or
Remove Links for Multiple Products Simultaneously.

Now that you have created links, you must enable product linking for them to take eect. See Enable Product Linking.

Create Links for One Product at a Time  
Create category and disposition links for one product at a time.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. In the Products column, identify the product you want to link.

◦ To view subproducts under a product, click the + sign next to a product to expand it.

◦ To nd a product, click Find and enter a search term in the Find window. The rst product that matches
your search term is highlighted in the tree. To continue searching, click Find Next.

Note:  Remember that you can link categories and dispositions only to products that are leaf products.
If the product you select has subproducts, the Category Links and Disposition Links buons are
disabled on the product editor.

4. Right-click the product you want to link and select Edit.
The product editor opens.

5. To create category links, click  Category Links. The category tree displays on the content pane.
a. Select the check boxes for each category you want to link to the product. If you select a category that

has subcategories, all subcategories are linked to the product. If you select a subcategory, all levels of its
parent category are implicitly linked.

b. Click Save.
6. To create disposition links, click  Disposition Links. The disposition tree displays on the content pane.

a. Select the check boxes for each disposition you want to link to the product. If you select a disposition that
has subdispositions, all subdispositions are linked to the product. If you select a subdisposition, all levels
of its parent disposition are implicitly linked.

b. Click Save.

Now that you have created links, you must enable product linking for them to take eect. See Enable Product Linking.

Create or Remove Links for Multiple Products Simultaneously  
Create or remove category and disposition links for multiple products simultaneously.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. On the Products/Categories/Dispositions editor, select the rst product you want to link.
4. Press Ctrl while selecting additional products.
5. After selecting the last product, right-click and select Edit.

The multi-edit window opens.
6. To create or remove category links, click Category Links.
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Note:  Although you can select top-level products on the editor, linking occurs only with leaf-level
products. If you want to create links for all of a top-level product’s leaf products, you must select
each of the leaf products separately instead of selecting only the top-level product. Because linking
occurs only between leaf-level products, categories, and dispositions, the links you create while multi-
editing do not apply to any top-level products you select, but only to the leaf-level products you select.
However, after you have created links to leaf products, the parent product is implicitly linked.

a. To link categories to the selected products, select the check boxes for each category you want to link in
the Add Categories column.

b. To remove category links from the selected products, select the check boxes for each category you want
to remove the link from in the Remove Categories column.

c. Click Save.
7. To create or remove disposition links, click Disposition Links.

a. To link dispositions to the selected products, select the check boxes for each disposition you want to link
in the Add Dispositions column.

b. To remove disposition links from the selected products, select the check boxes for each disposition you
want to remove the link from in the Delete Dispositions column.

c. Click Save.

Now that you have created links, you must enable product linking for them to take eect. See Enable Product Linking.

Link Categories to Products  
Product linking is bidirectional. Besides linking products to categories, you can also link categories to products.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. In the Categories column, right-click the category you want to link and select Edit.

You must select a leaf category (that is, one that has no subcategories). If you select a category that has
subcategories, the Product Links buon on the editor is disabled.
The category editor opens.

4. Click Product Links.
The products tree displays on the content pane.

5. Select the check boxes for the products you want to link to the category.
If you select a product that has subproducts, all subproducts are linked to the category. If you select a
subproduct, all levels of its parent product are implicitly linked.

6. Click Save.

Now that you have created links, you must enable product linking for them to take eect. See Enable Product Linking.

Link Dispositions to Products  
Product linking is bidirectional. Besides linking products, you can also link dispositions to products.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. In the Dispositions column, right-click the disposition you want to link and select Edit.

You must select a leaf disposition (that is, one that has no subdispositions). If you select a disposition that has
subdispositions, the Product Links buon on the editor is disabled.
The disposition editor opens.

4. Click Product Links.
The products tree displays on the content pane.
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5. Select the check boxes for the products you want to link to the disposition.
If you select a product that has subproducts, all subproducts are linked to the disposition. If you select a
subproduct, all levels of its parent product are implicitly linked.

6. Click Save.

Now that you have created links, you must enable product linking for them to take eect. See Enable Product Linking.

Enable Product Linking  
Enable product-category or product-disposition linking when you want to restrict the display of categories or
dispositions to only those that are linked to the selected product.

Product-category linking aects agents working with incidents and customers searching on the customer portal. Enable
product-disposition linking when you want to restrict the dispositions agents can select when working with incidents to
only those associated with the product they have selected.

Product-category linking and product-disposition linking are independent, so they are enabled separately. You can
enable either or both types of linking.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. To enable product-category linking, click  Enable > Product-Category Linking .
4. To enable product-disposition linking, click  Enable > Product-Disposition Linking .
5. Log out and then log back in for the changes to take eect.

Disable Product Linking  
Even after you have created product links, you can disable the product-linking feature.

When the feature is disabled, sta members can select any product-category and any product-disposition combination
when they work with incidents. On the customer portal, customers can select any product-category combination when
they conduct a search or request notications.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. To disable product-category linking, click Enable and clear the Product-Category Linking check box.
4. To disable product-disposition linking, click Enable and clear the Product-Disposition Linking check box.
5. Log out and then log back in for the changes to take eect.

Copy Product Links  
If you want a product to have the same category or disposition links as another product, simply copy the category links
or disposition links from the original product, and those links are applied to the product you are editing.

If you want to copy both category and disposition links, you must copy them each separately as described in the
following procedure.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. Do one of the following:

◦ Right-click the product you want to copy links to and select Edit to open the product editor.

◦ To select multiple products press Ctrl, right-click, and select Edit to open the multi-edit window.

4. Do one of the following:

◦ To copy category links, click Category Links on the ribbon.

◦ To copy disposition links, click Disposition Links on the ribbon.
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5. Click Copy Links From on the ribbon.
The Copy Links from Product window opens.

6. If necessary, expand the product tree to display the product you want to copy links from.
7. Select the product you want and click OK.
8. Click Save.

Note:  If the product you are editing already has existing links, these links are not removed by copying
links from another product. Instead, the product now contains both its original links as well as the
copied links.

Remove a Link  
There may be times when you want to remove product-category or product-disposition links, such as when your
organization modies dispositions as a result of a business process change.

You can manually remove product links one at a time. You can also remove multiple product links in one operation using
the multi-edit mode, described in Create or Remove Links for Multiple Products Simultaneously.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. Right-click the product you want to remove links from and select Edit.
4. To remove category links from the product, click Category Links.

a. To remove all category links from the product, click Remove All Links.
b. To remove specic category links, clear the check boxes for the categories you no longer want to link to

this product.
All associated implicit links are also cleared.

c. Click Save.
5. To remove disposition links from the product, click Disposition Links.

a. To remove all disposition links from the product, click Remove All Links.
b. To remove specic disposition links, clear the check boxes for the dispositions you no longer want to link

to this product.
All associated implicit links are also cleared.

c. Click Save and Close.

Product Linking When Working with Answers  
Regardless of whether product linking is enabled or of what categories are linked to products, all products and all
categories are available on the Products/Categories tab when you add or edit an answer.

When you select a product that has subproducts (including one or more levels of subproducts), all subproducts below
the product you selected are also selected, all the way down to the leaf level. Any parent product levels are also selected
implicitly. As these images show, selecting CA 9900 automatically selects that product’s subproducts. It also implicitly
selects the two parent levels: Conversa Phones and Mobile Phones.
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There may be times when you want to associate an answer with a top-level product but you do not want to associate
that product’s subproducts with the answer. In that case, you can right-click the product to select it without selecting
any of the subproducts. Instead of a check mark next to the product, you will see the check box lled in with the color
green, as shown in the following gure, where the Conversa product is selected but its subproducts are not.

The ribbon for the standard answer workspace contains a Validate Category Links buon that lets you determine if the
products and categories you selected for the answer are linked. If the categories you selected are linked to selected
products, a message informs you that all selected categories are linked to at least one selected product. If you select one
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or more categories that are not linked to the products you selected, a message lists the categories that are not linked to
any of the selected products.

View a Product Report  
You can view product, category, and disposition reports on the Products/Categories/Dispositions editor.

This procedure describes how to display a product report, but the procedure is the same for viewing category and
disposition reports.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Products/Categories/Dispositions.
3. Select the product for which you want to view a report.
4. Click Product Reports and select one of the available options: Visibility, Answers, Incidents, Category Links, or

Disposition Links.
The report displays on the lower part of the editor.

5. To see the answers, incidents, or category or disposition links associated with the product, click the value in the
Answers column.
A list of all records or links is displayed.

6. To minimize the report, click the icon with two down arrows next to the Undock icon at the far right of the
report header.

7. To display the same report for a dierent product, select the product and click Refresh in the report header (not
Refresh on the ribbon).

8. To copy information in a report column (for example, to copy an incident reference number so you can search
for the incident), right-click the item and select Copy Cell to Clipboard.

Reports can also be viewed when you are editing an individual product, category, or disposition. The reports are
available as buons on the editor ribbon.

The following reports are available for products.

• Visibility—Shows the product and all subproducts with check marks in the Admin and End-user columns that
indicate where the product is visible on each interface.

• Answers—Shows the product, including any subproducts, and the number of answers associated with each.
You can then drill down on the number of answers to view all answers associated with the specic product.

• Incidents—Shows the product, including any subproducts, and the number of incidents associated with each.
You can then drill down on the number of incidents to view all incidents associated with the specic product.

• Category Links—Shows the number of category links for the selected product. (If the selected product is a
parent product, category links are displayed for each of the subproducts that is linked to a category.) You can
drill down on the number of links to view the category links for each product.

• Disposition Links—Shows the number of disposition links for the selected product. (If the selected product is a
parent product, disposition links are displayed for each of the subproducts that is linked to a disposition.) You
can drill down on the number of links to view the disposition links for each product.

The following reports are available for categories.

• Visibility—Shows the category and all subcategories with check marks in the Admin and End-user columns
that indicate where the category is visible on each interface.

• Answers—Shows the category, including any subcategories, and the number of answers associated with each.
You can then drill down on the number of answers to view those answers.
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• Incidents—Shows the category, including any subcategories, and the number of incidents associated with each.
You can then drill down on the number of incidents to view those incidents.

• Category Links—Shows the number of product links for the selected category. You can drill down on the
number of links to view the products linked to each category.

The following reports are available for dispositions.

• Visibility—Shows the disposition and all subdispositions with check marks in the Admin column that indicate
where the disposition is visible on each interface. (Dispositions are not visible on the customer portal so End-
user visibility is not an option.)

• Incidents—Shows the disposition, including any subdispositions, and the number of incidents associated with
each. You can then drill down on the number of incidents to view those incidents.

• Disposition Links—Shows the number of product links for the selected disposition. You can drill down on the
number of links to view the products linked to each disposition.

Overview of Incident Statuses  
The four default incident statuses may be enough for your organization. However, if additional incident statuses can
help you beer organize the incidents in the knowledge base, you can add them.

An incident’s status is its state in the knowledge base. Service has four default incident statuses: Solved, Unresolved,
Updated, and Waiting. Additionally, there are three default status types, which are Solved, Unresolved, and Waiting.
These are displayed in the drop-down menu in the Status column on the editor. Not surprisingly, the Solved incident
status uses the Solved status type. Likewise, the Waiting status uses the Waiting status type, and the Unresolved status
uses the Unresolved status type, which is also used by the Updated status. You can rename the default statuses, but you
cannot change their types, which are disabled on the Incident Statuses editor. The following list describes the default
incident statuses.

• Solved—The incident has been resolved.

• Unresolved—The incident has been recently added, either by an agent or a customer.

• Updated—The incident has been updated by a customer through the Your Account page or by replying to an
agent’s email.

• Waiting—An agent has responded to the incident and is waiting for a response from the customer. If the
customer does not respond within the time specied in CI_HOURS (Agedatabase Utility > Batch Processing >
Close Incidents), Agedatabase sets the incident status to Solved.

Service can automatically set an incident’s status when agents send a response. This is a property of the Incident
Thread relationship item that can be set when you create an incident workspace. The property is called Status Change
on Response, and you can set it for one of the following options:

• The status does not change when an agent sends a response.

• The status changes to Waiting.

• The status changes to Solved.

For information about seing properties for relationship items on workspaces, see Overview of Workspace and Script
Elements.

The four default incident statuses may be enough for your organization. However, if additional incident statuses can
help you beer organize the incidents in the knowledge base, you can add them. When you add an incident status, you
must assign it to one of the three default status types.
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Note:  If you delete a custom incident status, all incidents set to that status are changed to the default status
with the same status type. For example, if you delete a custom incident status with the status type Solved,
all incidents that were associated with that status are changed to the Solved incident status with the Solved
status type.

Add or Edit an Incident Status  
If necessary, you can add a new incident status or edit an existing one.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree displays on the content pane.
3. Expand the System Menus folder.
4. Click Incident Statuses to display the editor.
5. Do one of the following:

◦ To add an incident status, click New.

◦ To add a new incident status directly below an existing incident status in the tree, select the existing
incident status and click New.

◦ To edit an incident status, click it in the tree.

You can change the names of the default incident statuses, but the functionality of each remains the same.
Incidents with the same status type behave the same way, regardless of their name.

6. Enter a name for a new incident status or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click the Status drop-down menu and select a status type. Options include Unresolved, Solved, and Waiting.
After you save an incident status, you cannot change its status type.

8. Click Save.

Add or Edit an Incident Severity Level  
Your organization might nd it useful to classify incidents by their severity level so that agents can resolve the highest
severity incidents rst.

Additionally, reports that include incident severity can be useful management tools.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Incident Severities to display the editor.
5. Do one of the following:

◦ To add an incident severity, click New.

◦ To add a new incident severity directly below an existing incident severity in the tree, select the existing
incident severity and click New.

◦ To edit an incident severity, click it in the tree.
6. Enter a name for a new incident severity or edit an existing one in the Label column.

The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.
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7. If you do not want the incident severity to be visible on the interface, clear the Visible check box.
8. Click Save.

How You Route Incidents to Queues  
Using incident rules, you can route unresolved incidents to dierent queues based on the criteria you dene.

For example, you might add incident queue for dierent product lines or service areas. Or you might have a rst tier
for basic customer service and additional tiers for problems of increasing complexity. When you create prole for sta
accounts, you can assign one or more queues to each prole and specify how incidents are pulled from that queue.
Based on their prole, agents can retrieve a specied number of incidents from the queues to which they have access.

Queues also help you manage incident escalation to meet your organization’s service level agreements (SLA (service
level agreement)), balance agent workload, and track agent productivity and eciency.

You can perform any of these tasks when managing queues.

Task Description

Add queues
 

You can select a default queue to which all new incidents are automatically routed, and you can add
multiple incident queues for eective incident routing. See Add or Edit an Incident Queue.
 

Assign queues to proles
 

You can dene available queues, queue ranking, pull policy, pull quantity, and inbox limit for sta
members with the prole. See Proles.
 

Create business rules to populate queues
 

You can create business business rules to automatically assign incoming incidents to incident queues
based on conditions you specify. Incident rules have a Set Field/Queue ID action you can use to route
queues based on the conditions of the rule. See Add a Rule.
 

Instruct agents about queues
 

Agents can manually pull incidents from queues assigned in their prole. When agents log out, the
unresolved incidents in their inbox remain there unless they assign them back into a queue. See
Reassign or Re-Queue an Incident.
 

Monitor queues
 

Agents can monitor queuing statistics through the Queues report, where queued incidents and
statistics are displayed. Queue statistics can be regenerated at any time. See How You Monitor Incident
Queues.
 

Add or Edit an Incident Queue  
When adding an incident queue, you can dene whether the queue uses a round-robin incident assignment and specify
the queue as the default queue where unassigned incidents are routed.

You can also delete queues from the Incident Queues editor.

Before you can access incident queues, your prole for Service permissions must allow incident queues. In addition to
queue access, Service permissions also dene queue rank, pull policies and quantities, and inbox limits. See Service
Permissions.
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Note:  If you try to delete an incident queue that is used in a business rule, a window opens to display the rules
that depend on the queue. Before you can delete the incident queue, you must rst edit the rules so they no
longer use the queue.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Incident Queues to display the editor.
5. Do one of the following:

◦ To add an incident queue, click New.

◦ To add a new incident queue directly below an existing incident queue in the tree, select the existing
incident queue and click New.

◦ To edit an incident queue, click it in the tree.

6. Enter a name for a new incident queue or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click the Queue Type drop-down menu and select one of the following options: Standard, Round Robin (All), or
Round Robin (Logged In).

Note:  A round-robin queue automatically assigns incidents in this queue to agents in a rotating
fashion. For example, if four agents are assigned to the round robin queue, incidents are assigned in
this order: Agent 1, Agent 2, Agent 3, Agent 4, Agent 1, Agent 2, and so on. If you select Round Robin
(All), incidents are assigned to all sta members whose prole includes the queue, even if they are not
logged in.

8. To designate the queue for use with advanced routing of incidents, select the Advanced Routing option and
enter the following eld information. Advanced Routing must be enabled for this option to appear. .

The Advanced Routing seings are described in the following table.

Field Description

Starting Minimum Score Enter a value from 0 to 5 for each skill. Incoming chats will be rst routed to those

agents meeting this score.

Lowest Minimum Score Enter a value from 0 to 5 for each skill. Only agents meeting this minimum skill level

can be assigned chats from this queue.

Relax Score Requirement After Enter a value in seconds for the queue. The score requirement will be relaxed after the
time you specify. Skills are relaxed at the queue level. A value of 0 seconds disables skill
relaxation.

Score Decrement Amount Enter the score value from 1 to 5 for each skill to be decremented when it meets the

relaxation time.

Overow Timer Enter a value in seconds after which the chat will be routed equally to agents assigned
the queue as a primary or an overow. Overow will be disabled if this eld is set to 0,
 and only agents assigned the queue as a primary will receive chats from this queue.

9. If you want this incident queue to be the default queue, select the Default check box.
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Only one queue can be the default queue. If a default queue has already been identied and you select the
default check box for this queue, this queue becomes the default.

10. Click Save.

How You Monitor Incident Queues  
Sta members with the appropriate permissions can monitor incident queues using the Queues report.

Depending on their prole, this report may appear in any navigation list designated by the administrator.

The Queues report lets sta members drill down to display the agents who are currently handling incidents and the
incidents themselves. For a real-time snapshot of all queues at any time, click Refresh.

How You Organize Answer Statuses  
An answer’s status controls whether it is public and describes its state in the knowledge base.

If you want to organize the answers in the knowledge base with a greater level of classication than that oered by the
default answer statuses in Service, you can add more answer statuses.

Service provides four default answer statuses, described in this list. Every answer status is associated with a status type
that is either Public or Private.

• Private—The Private answer status prevents answers from being displayed on the administration interface and
the customer portal. It is associated with the Private status type.

• Proposed—Answers with the Proposed status are incidents that agents have submied as potential answers for
the knowledge base. Proposed answers are associated with the Private status type.

• Public—Answers with the Public status are visible on the customer portal. Public answers have a Public status
type.

• Review—The Review answer status means the answer should be evaluated to determine if it is still necessary.
An answer’s status is set to Review when it has been part of the knowledge base for a specied amount of time
or when its solved count reaches zero. See Solved Count Aging. Answers with a Review status are associated
with a Private status type by default.

Note:  If you delete a custom answer status, all answers with that status are changed to have either a Public or
Private status, depending on the status type of the deleted answer status. For example, if you delete a custom
answer status with a Public status type, all answers that were associated with that status are changed to Public
status with the Public answer status type.
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Related Topics
• Add or Edit an Answer Status

Add or Edit an Answer Status  
You can add a new answer status or edit an existing one.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Answer Statuses to display the editor.
5. Do one of these:

◦ To add an answer status, click New.

◦ To add a new answer status directly below an existing answer status in the tree, select the existing answer
status and click New.

◦ To edit an answer status, click it in the tree.

Note:  You can change the names of the default answer statuses, but the functionality of each remains
the same. Answers with the same status type behave the same way, regardless of their name.

6. Enter a name for a new answer status or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click the Status drop-down menu and select Public or Private.

After you save the answer status, you cannot edit its status type. Answers set to the Private status type are not
visible on the customer portal, even if you select end-user visibility on the answer access level. They are also
not visible on the administration interface.

8. Click Save.

How You Control Answer Access  
Answer access levels provide a way to control which answers in the knowledge base become public and visible to
customers.

In addition to the default answer access levels, you can add custom answer access levels to allow specic contacts and
organizations to view certain groups of answers that are not available to all customers.

Service has these default answer access levels:

• Help—The Help answer access level provides online help to customers through context-sensitive answers.

• Everyone—The Everyone answer access level makes answers visible to all sta members and customers.

You cannot delete the Help and Everyone answer access levels, although you can rename them.

In addition to the default answer access levels, you can add custom answer access levels to allow specic contacts and
organizations to view certain groups of answers that are not available to all customers.
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You control the answers customers can view when you create a service level agreement (SLA) and select custom access
levels to associate with it. Customers with that SLA can view answers having those custom access levels. See Create an
SLA for information about assigning answer access levels to an SLA.

In order for answers to appear on the customer portal, the Status, Language, Access Level, Product, and Category elds
must be set to a visibility that allows access by customers. If even one eld does not allow visibility, the answer is not
visible on the customer portal. In addition, if you have sections within an answer with restricted visibility, that section
must be assigned an access level associated with the answer and have end-user visibility selected. See How to Control
Answer Visibility.

Sibling answers with access levels that are at or below the contact’s SLA are visible to the contact. See Sibling Answers.

Related Topics
• Add or Edit an Answer Access Level

Add or Edit an Answer Access Level  
You can add a new answer access level or edit an existing one.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Answer Access Levels to display the editor.
5. Do one of these:

◦ To add an answer access level, click New.

◦ To add a new answer access level directly below an existing answer access level in the tree, select the
existing answer access level and click New.

◦ To edit an answer access level, click it in the tree.

6. Enter a name for a new answer access level or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. If you do not want the answer access level to be visible on the interface, clear the Visible check box.
8. Click Save.

Billable-Task Tracking  
The Time Billed feature in Service lets you track the amount of time agents spend on customer issues and questions.

When you enable this feature, agents can add their time to an incident as they work on it. Service contains one default
billable task, Miscellaneous, and you can add any custom billable tasks that meet your organization’s needs.

For example, you might add a Telephone billable task to see how much time agents are spending on the telephone
answering customer questions. See Add Time Billed to an Incident learn how agents record billable time when they work
on incidents.

Note:  You cannot delete the Miscellaneous billable task. If you delete a custom billable task, all occurrences of
that task in incidents have no value and you may lose valuable time-tracking information.
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The standard incident workspace contains the Time Billed tab. To enable the feature on other workspaces, add the Time
Billed relationship item to the workspace. Other Time Billed properties include the ability to require agents to enter time
billed before they mark an incident solved or whenever they edit an incident. These properties are Time Required for
Edit and Time Required for Solved. See Create a Workspace.

Related Topics
• Add or Edit a Billable Task

Add or Edit a Billable Task  
You can add a new billable task or edit an existing one.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Billable Tasks to display the editor.
5. Do one of the following:

◦ To add a billable task, click New.

◦ To add a new billable task directly below an existing billable task in the tree, select the existing billable
task and click New.

◦ To edit a billable task, click it in the tree.

6. Enter a name for a new billable task or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click Save.

How Channel Types Work  
Channel types are used by contacts to provide their user names for Twier, YouTube, and Facebook through the
customer portal.

By providing user name information, the contact’s incidents are automatically associated with the contact. This assists
agents in identifying and responding to contacts who are using Twier, YouTube, and Facebook.

If given the proper visibility through the Channel Types editor, contacts and sta members can add and edit channel
type user names.

• Contacts can add and edit their Twier, YouTube, and Facebook user names through widgets on the customer
portal.

• Sta members can add and edit Twier, YouTube, and Facebook user names for contacts from a custom
contact workspace.

The standard contact workspace does not contain a eld for channel usernames. If you want your agents to add
information about channel user names, you must add the Channel Usernames eld to a custom contact workspace and
assign that workspace to the prole used by agents.

See Edit a Channel Type to rename or remove channel types.
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Related Topics
• Overview of Channels

• Input Widgets

• Create a Workspace

Add the Channel Usernames Field to a Contact Workspace  
The standard contact workspace does not contain a eld for channel usernames. If you want your agents to add
information about channel user names, you must add the Channel Usernames eld to a custom contact workspace.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces.

The Workspaces explorer opens.
3. Right-click the custom contact workspace you want to add the eld to and select Open.

You cannot edit the standard contact workspace, but you can copy it and edit the copy.
4. Click the Insert Field tab on the ribbon.
5. Click the Channel Usernames eld, move the cursor to where you want to position the eld on the workspace,

and click to place the eld.
6. To change the eld label, adjust the size, make it a read-only eld, or make it a required eld, click the eld on

the workspace and select options on the ribbon’s Design tab.
7. Click Save.
8. Assign this workspace to a prole used by your agents. See Proles if you need help with this process.

Edit a Channel Type  
You can permit sta members and contacts to add and edit social media user names based on the channel type
visibility seings.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Click the System Menus drop-down arrow, then click Channel Types.

The Channel Types editor is displayed.
4. To rename a channel type:

a. Click it in the Label column.
The Interface Visibility section displays, showing the names of all available interfaces, the languages
they are implemented in, and the language-specic label of the channel.

b. Enter the new name for the channel type. When you move to another eld, the Label eld in the Interface
Visibility section is populated with the name you typed.

Note:  When using multiple-language interfaces, enter the label in the Label eld in the
language of the interface.

5. To remove channel type visibility for sta members and contacts, clear the Contact Visible check box next to
the applicable channel type.
This removes sta member visibility for the channel type in the Channel Usernames eld on custom contact
workspaces. In addition, visibility is removed from the applicable widget on the customer portal.

6. To change the display sequence of channel types on the custom contact workspace and the customer portal,
click the up or down arrow next to the Contact Visible column.

7. Click Save.
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Tracked Link Categories for Outreach and Feedback  
You can add tracked link categories to your Oracle RightNow Outreach Cloud Service (Outreach) and Oracle RightNow
Feedback Cloud Service (Feedback) applications to group and organize tracked links.

When tracked links are assigned to categories, you can enhance your reporting on customer clicks of links in your
mailings and surveys. You can also see how certain categories performed and which are geing the most hits. For
example, you could create tracked link categories for each of your product oerings on your website. You can also delete
tracked link categories on the editor.

Note:  Use care when deleting tracked link categories. When you delete a tracked link category, the category is
set to Unspecied and you may lose tracking data as a result.

Related Topics

Add or Edit a Tracked Link Category  
You can add tracked link categories to your Outreach and Oracle RightNow Feedback Cloud Service (Feedback)
applications to group and organize tracked links.

1. Click Conguration on the navigation pane.
2. Expand Outreach, and then double-click Tracked Link Categories.

The tree displays on the content pane.
3. Do one of the following:

◦ To add a tracked link category, click New.

◦ To edit a tracked link category, click it in the tree.

Note:  Use care when deleting tracked link categories. When you delete a tracked link category,
the category is set to Unspecied and you may lose tracking data as a result.

To add another parent-level tracked link category in the same session, you must rst press Ctrl and click the
highlighted category in the tree (to deselect it) before clicking New.

4. Enter a new name or edit an existing one in the Tracked Link Category Name eld.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

5. To add a description to the tracked link category, enter one in the Description eld.
The Description eld in the Interface Visibility section is populated or revised when you move the cursor to a
dierent eld or save the tracked link category.

6. If you do not want the tracked link category to be visible on the interface, clear the Visible check box.
7. Click Save.

Add Levels of Tracked Link Categories  
By adding levels of tracked link categories to Outreach and Feedback, you can further classify your tracked links.

You can add a subordinate category level by selecting a tracked link category and clicking New. You can create up to six
levels of tracked link categories.

1. Click Conguration on the navigation pane.
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2. Expand Outreach, and then double-click Tracked Link Categories.
The tree displays on the content pane.

3. Click the tracked link category you want to add a level to and click New.
4. Enter the name and description of the subcategory.
5. Click Save.

The new category level appears under the category in the tree.
6. Click Save to save the subcategory.

Add or Edit a Contact Role  
Contact roles allow sales representatives to identify contacts according to their role in opportunities.

Contacts can be associated with multiple opportunities, but their roles in each opportunity can be dierent. For
example, a contact might be a buyer in one opportunity and a reference in another. By dening contact roles, your sales
representatives can select a contact role for the contacts associated with an opportunity. Based on this information,
your sta members know which contact to work with at each point in the sales cycle.

Contact roles are specic to Opportunity Tracking. Therefore, sta members see the Set Contact Role buon only when
they edit contacts that are associated with an opportunity.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Contact Roles to display the editor.
5. Do one of the following:

◦ To add a contact role, click New.

◦ To add a new contact role directly under an existing contact role in the tree, select the existing contact
role and click New.

◦ To edit a contact role, click it in the tree.

6. Enter a name for a new contact role or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Enter any notes regarding the contact role in the Notes eld.
8. Click Save.

Add or Edit an Opportunity Status  
Opportunity statuses represent the current state of opportunities in your knowledge base.

When sta members assign a status to an opportunity, one of the seven default opportunity status types is also
assigned. The seven default opportunity statuses include Lead, Reject, Active, Closed, Lost, Inactive, and Dead. You
can dene additional statuses if you need them. For example, if your organization uses a Pending custom opportunity
status that is assigned the Active status type, any opportunities set to the Pending status will be considered active. The
default status types are displayed in the drop-down menu in the Status column on the editor.
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Note:  If you delete a custom opportunity status, all opportunities set to that status are changed to the default
status with the same status type. For example, if you delete a custom opportunity status with the status type
Active, all opportunities that were associated with that status are changed to the Active opportunity status
with the Active status type.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Opportunity Statuses to display the editor.
5. Do one of the following:

◦ To add an opportunity status, click New.

◦ To add a new opportunity status directly below an existing opportunity status in the tree, select the
existing opportunity status and click New.

◦ To edit an opportunity status, click it in the tree.

Note:  You can change the names of the default opportunity statuses, but the functionality of each
remains the same. Opportunities with the same status type behave the same way, regardless of their
name.

6. Enter a name for a new opportunity status or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. Click the Status drop-down menu and select a status type.

Note:  After you save an opportunity status, you cannot change its status type.

8. Click Save.

Add or Edit a Competitor  
A competitor is any individual or organization who is selling goods or services in the same industry as your
organization. When adding or editing an opportunity, sales representatives can select from a list of competitors that you
dene.

Using this information, you can track which other parties are competing for your opportunities and whether your
organization is winning or losing to them.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Competitors to display the editor.
5. Do one of the following:

◦ To add a competitor, click New.

◦ To add a new competitor directly below an existing competitor in the tree, select the existing competitor
and click New.

◦ To edit a competitor, click it in the tree.
6. Enter a name for a new competitor or edit an existing one in the Label column.
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The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. If you do not want the competitor to be visible on the interface, clear the Visible check box.
8. Click Save.

Add or Edit a Win/Loss Reason  
When adding or editing an opportunity, sales representatives can select from a list of win/loss reasons that you dene.

Using this information, you can track the main reasons why your organization is winning or losing opportunities.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Win/Loss Reasons to display the editor.
5. Do one of the following:

◦ To add a win/loss reason, click New.

◦ To add a new win/loss reason directly below an existing win/loss reason in the tree, select the existing
incident win/loss reason and click New.

◦ To edit a win/loss reason, click it in the tree.

6. Enter a name for a new win/loss reason or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. If you do not want the win/loss reason to be visible on the interface, clear the Visible check box.
8. Click Save.

How Industry Types Work  
Industry types allow sta members to classify organizations according to the industry they are associated with. When
adding or editing an opportunity, sales representatives can select from a list of industry types that you dene.

Using this information, you can track which industries your customers are associated with.

The standard opportunity workspace does not contain a eld for industry type. If you want your sales representatives
to add information about industry types, you must add the Industry eld to an opportunity workspace and assign that
workspace to the prole used by sales representatives. See Add the Industry Field to an Opportunity Workspace to add
this eld to an opportunity workspace. Also see Create a Workspace.

To add or edit an industry type, see Add or Edit an Industry Type.

Add the Industry Field to an Opportunity Workspace  
Industry types allow sta members to classify organizations according to the industry with which they are associated.
If you want your sales representatives to add information about industry types, you must add the Industry eld to an
opportunity workspace and assign that workspace to the prole used by sales representatives.

The standard opportunity workspace does not contain a eld for industry type.

1. Click Conguration on the navigation pane.
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2. Expand Application Appearance, and then double-click Workspaces.
The Workspaces explorer opens.

3. Right-click the custom opportunity workspace you want to add the eld to and select Open.
You cannot edit the standard opportunity workspace, but you can copy it and edit the copy.

4. Click the Insert Field tab.
5. Click Opportunity Fields and select Organization Fields to view organization elds you can add to the

workspace.
6. Click the Industry eld, move the cursor to where you want to position the eld on the workspace, and click to

place the eld.
7. To change the eld label, adjust the size, make it a read-only eld, or make it a required eld, click the eld on

the workspace and select options on the Design tab.
8. Click Save.
9. Assign this workspace to the prole used by sales representatives. See Proles if you need help with this

process.

Add or Edit an Industry Type  
Industry types allow sta members to classify organizations according to the industry they are associated with. When
adding or editing an opportunity, sales representatives can select from a list of industry types that you dene.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Industry Types to display the editor.
5. Do one of the following:

◦ To add an industry type, click New.

◦ To add a new industry type directly below an existing industry type in the tree, select the existing industry
type and click New.

◦ To edit an industry type, click it in the tree.

6. Enter a name for a new industry type or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. If you do not want the industry type to be visible on the interface, clear the Visible check box.
8. Click Save.

Add or Edit a Lead Rejection Type  
A lead is an opportunity that has been prequalied by your marketing or service department, associated to a sales stage
with a Lead status type, and assigned to a sales representative. Sales representatives can either accept or reject a lead.

When sales representatives reject leads, they must select from a list of lead rejection types. Using this information, you
can track why leads are being rejected.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus .

The Customizable Menus tree opens on the content pane.
3. Expand the System Menus folder.
4. Click Lead Rejection Types to display the editor.
5. Do one of the following:
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◦ To add a lead rejection type, click New.

◦ To add a new lead rejection type directly below an existing lead rejection type in the tree, select the
existing lead rejection type and click New.

◦ To edit a lead rejection type, click it in the tree.

6. Enter a name for a new lead rejection type or edit an existing one in the Label column.
The corresponding eld in the Label column in the Interface Visibility section is populated or revised as you
type.

7. If you do not want the lead rejection type to be visible on the interface, clear the Visible check box.
8. Click Save.

Business Rules  

Overview of Business Rules  
Business rules are powerful tools for simplifying and automating common business tasks. They link data from all Oracle
Service Cloud products in the knowledge base, resulting in a responsive, consistent customer experience.

A business rule is an “if-then” statement: If these conditions apply, then take this action. For example, if a customer has
a billing question, then route the incident to an accounting sta member. If a new contact is from the East Coast, then
send a marketing email about the opening of a New York store. If an agent proposes an answer for the knowledge base,
then route that answer to the knowledge engineer for review.

Business rules can also include an Else clause: If the conditions of the rule are not met, then take a dierent action.
Extending the billing question example, a rule can route the incident to accounting. If the question is not about billing
(that is, the incident does not match the rule condition), then route it to technical support.

Oracle Service Cloud has eight rule types:

• Answer

• Chat

• Contact

• Custom Object

• Incident

• Oer Advisor

• Opportunity

• Organization

• Task

Each of these sets of rules—including the associated states, functions, and variables—is a rule base. The entity to which
a rule base applies—answer, incident, contact, chat, opportunity, organization, target (for Oer Advisor rules), task, or
custom object—is known as the object type.

Note:  Every object type has its own rule base, and every rule base is separate from other rule bases. The
contacts rule base processes only contacts, the organizations rule base processes only organizations, and so
on.
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Business rules help you provide a consistent, accurate, and timely experience for customers while streamlining the
eciency of sta members. When the rules engine updates information automatically and immediately, your entire
organization has access to a knowledge base that is accurate and current in every customer interaction. For example,
marketing sta members always know a customer’s email preferences, even when the customer changes opt-in
choices. Sales representatives can be sensitive to a prospective customer when they know the customer is experiencing
technical support issues. And agents can reinforce your organization’s marketing campaigns when they know what
emails a customer has received.

Besides the many advantages of keeping the knowledge base accurate and current, business rules also let sta
members work eciently and consistently. When you create rules to answer routine customer questions, customers
enjoy an immediate response. At the same time, sta members work more productively without the distraction of
repetitive tasks. As a result, they can deliver more responsive customer service and follow-up.

Business rules route incidents to the suitable support person, notify an engineer when answers in the knowledge
base should be reviewed, and automatically answer customer questions. They send marketing emails and surveys.
They escalate overlooked opportunities and set strategies based on conditions you dene. Rules update contacts and
organizations, set custom elds, and assign tasks. For specic examples of business rules with a discussion of the logic
used to create them, see Examples of Business Rules.

Related Topics
• How are Rules Processed?

• Ways to Use Business Rules in Your Organization

• Best Practices for Planning Business Rules

• Elements of Rules and Rule Bases

• How to View Rule Bases

• Compilation and Activation of Rule Bases

• Create a Rule Base

• Add a Rule

• Modify a Rule Base

How are Rules Processed?  
The rules engine is the software that processes the rules in a rule base.

The rules engine begins processing when:

• Sta members add or edit answers, contacts, incidents, opportunities, organizations, or tasks.

• Customers submit questions on the Ask a Question page.

• Customers update their contact records or incidents.

• Customers request chat sessions.

The rules engine looks at every new or updated object and checks to see if the conditions of any rules are met. If rule
conditions are met, the action associated with that rule occurs.

Assume, for example, that you add a contact. Adding the contact triggers the rules engine to begin processing rules
in the contact rule base. The rules engine applies rules to the contact, checking to see if the contact matches the
conditions of any of the rules. If the contact matches the conditions of a rule, the rules engine executes the action in
that rule. The action might apply an SLA to the contact, set the state, send a marketing email, or perform any other
action in the contact rule base. If the contact matches conditions in multiple rules, the actions of all those rules occur.
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The next time the contact record is updated by the customer or a sta member, the rules engine processes the contact
again.

Note:  The rules engine is triggered when the contact (or other object) is updated, not when the rule base is
updated. If you create or edit a rule, objects are not evaluated to see if they meet the conditions of the new or
updated rule. Rules processing happens only when objects are added or updated.

Ways to Use Business Rules in Your Organization  
There are many ways you can use rules to automate workow in your organization.

These are some common ways to use business rules:

• Route incoming incidents—Use rules to route incoming questions to the most qualied sta member, group, or
queue based on criteria you dene, such as product, incident severity, or language.

• Escalate answers, incidents, opportunities, and tasks—Assess potential problems and alert managers to critical
issues by using escalation levels. Identify tasks with elapsed deadlines, and escalate incidents that have not
received timely responses. Escalate answers to ensure adequate review, and follow up on opportunities to
prevent ignoring potential sales.

• Update answers, contacts, incidents, opportunities, organizations, and tasks and notify sta members—Create
rules to consistently handle and track updates to answers, contacts, incidents, opportunities, organizations, and
tasks and notify sta members when assignments have changed.

• Suggest answers to incoming questions—Business rules let you suggest answers to customers’ questions
before they submit them. When rules successfully answer questions, fewer incidents are added, reducing
agents’ workloads.

• Create SLA instances for contacts and organizations—Automatically apply SLA instances for contacts and
organizations. For example, create a rule to apply SLA instances to all customers who submit questions about a
new product. See Overview of Service Level Agreements.

• Route chat requests to queues—Route requests for chat sessions to a specic queue to manage chats
optimally. See Chat for Agents, Supervisors, and Customers for information about chat sessions.

• Send marketing email—Send email to contacts who meet specic conditions. For example, send a regional
email message to all contacts within a specic geographic area or a product-specic message for opportunities
with a certain status. See Overview of Mailings for complete details about creating, managing, and sending
marketing email.

• Conduct surveys—Automatically distribute surveys to customers to monitor customer satisfaction and other
performance measures. See Overview of Surveys for complete details about creating, managing, and sending
surveys.

• Dene target customers for promotions—Use Oer Advisor rules to assign customers who meet certain criteria
to specic target groups. Then agents who are solving incidents can use Oer Advisor to present oers to
eligible customers. See Overview of Oer Advisor Administration for information about conguring Oer
Advisor and Overview of Incidents to learn how agents use the feature.

Related Topics
• Examples of Business Rules

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks
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Best Practices for Planning Business Rules  
Before you begin creating rules for your organization, it is important to examine your business processes, including how
you update contacts and organizations, handle incidents and answers, route requests for chats, follow up opportunities,
and dene targets for marketing promotions.

After you have a clear idea of the processes your organization uses, you can develop an eective method for applying
business rules to automate these processes. This section describes the essential steps to help you get started.

Identify and outline business processes—To create a more ecient system for handling routine procedures, rst outline
the procedures to determine what processes can be automated.

For example, if you routinely assign questions about one product to a certain queue, you can create a rule to
automatically route those incidents to the queue. Or if opportunities are not followed up promptly, rules can escalate
those opportunities after a certain amount of time.

Review this list of questions to trigger ideas for designing business rules that can increase eciency in your
organization:

• How do you handle incoming customer questions?

• What is the review process when answers are created?

• What happens when incidents are reassigned to other agents?

• How does management get involved when incidents remain unresolved?

• What happens when sales opportunities are identied?

• How are prospective customers contacted?

• How do you identify target groups for promotions?

• How can you group incoming customer questions and route them most eectively?

• Which inquiries are not being handled properly?

• What other processes can you use to automatically route and manage incoming questions, responses, and
updates?

Develop a rules owchart—Flowcharts are useful for viewing and grouping processes to determine the best way to
apply business rules. Creating a owchart can help you:

• Organize business processes.

• Gain process consensus between management and sta.

• Develop a blueprint for sta training.

• Develop thorough testing methods with less backtracking.

• Create an overview of the information management process.

• Provide a future point of reference.

Review functionality of rules—After mapping your organization’s processes, review what rules can do to automate
them. When you understand how rules function, you can begin planning ways to implement them.

Create rules—Once you understand how rules work, you can create rules to automate business processes. Begin by
reviewing the owchart of current processes to determine the most appropriate methods for automating routine
processes.

Prioritize processes for applying rules—You must consider the organization of states, functions, and rules to ensure that
rules perform as you intend them to. Rules in a state process in order until all the rules process or until a rule transitions
to a function or a dierent state or stops processing.
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Verify and ne-tune rules—An important part of conguring rules is verifying that they perform as expected.

Train sta—Once you set up rule bases, you must train your sta. They should be familiar with how your organization
handles routine business procedures, how rules automate those procedures, and how their positions play a role in rules
processing.

Evaluate processes and rules as required—Once you start adding rules to automate processes and become more
familiar with them, you can consider more ecient and eective ways to route and manage data. Periodically reevaluate
your business processes looking for more eective ways to handle questions, responses, updates, and opportunities.
Also reevaluate when your organization experiences workow changes. For example, update routing rules when sta
accounts are added or removed.

As you examine your business processes and think about automating them with rules, it is helpful to understand how
to design eective business rules. Elements of Rules and Rule Bases provides an overview of the elements of business
rules so you can begin designing and working with rules.

Related Topics
• Create a Rule Base

Elements of Rules and Rule Bases  
Before you create a rule base, you should be familiar with the elements of rules and rule bases and how these elements
are related.

When you open the rules editor, the left side of the content pane displays the rules in each of the rule base states and
functions as well as a list of the rule base variables. The right side of the content pane is the editor, which lets you add
and edit states, functions, and variables for a rule base. This is also where you add and edit conditions and actions for
individual rules.

States and functions—States and functions provide a way for you to organize business rules and dene the sequence
for processing rules. Each rule base must have at least one state—the initial state—before rules processing can begin.

Variables—A variable is a piece of data with a value that can change during rules processing. You dene what its default,
or starting, value should be. Then, based on conditions you specify, the variable can be modied by rule actions. You
can also use the value of a variable as a condition of a rule. The value of the variable is temporary, existing only during
the particular rules processing session. When rules processing is started the next time, the variable value is reset to the
default value.

Conditions—A rule is basically an “if-then” statement. If something meets this condition, then take this action. The “if”
statement is the rule condition. An example of a condition statement is “If the contact’s state equals Montana.” Each
rule base has a unique set of conditions that the rules engine can use to evaluate the object.

Note:  Keep in mind that having multiple conditions in a rule is more common than having only one. For the
sake of simplied discussion, assume that any singular “condition” referenced in this section may actually be a
set of conditions.

Logical expressions—When you add two or more conditions, rules processing uses a logical expression to dene the
relationship of the conditions. Logical expressions join conditions using an AND (&) or an OR (|) relationship between
them. For example, you might want to look for customers who have purchased Product A and who have also purchased
a one-year warranty. Or you might want to nd customers who have purchased Product A or Product B. The default
logical expression joins all conditions with AND. If you want all conditions to apply, it is not necessary to edit the logical
expressions.
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Actions—Actions comprise the “then” part of an “if-then” rule or the “then” and “else” parts of an “if-then-else” rule.
If the conditions you specied in a rule are met, then the rules engine implements the rule actions. The list of available
actions depends on the rule object type. An action can be as simple as stopping the rules processing or more complex,
such as assigning an incident to an agent, sending that agent a notication, and dening an escalation process if the
incident is not resolved within a certain time frame.

States and Functions in Business Rules  
States and functions provide a way for you to organize business rules and dene the sequence for processing rules.
Each rule base must have at least one state—the initial state—before rules processing can begin.

States and functions are listed alphabetically in the Rules tree, and the rules within each state and function are listed in
the order in which you want them to execute.

States are containers for rules. You can add as many states as you need for each stage of your business. You can set
up rules in the initial state, for example, that are applied to all new opportunities (or other object type, depending on
the rule base). Then, depending on the conditions of rules in the initial state, you can transition the opportunity into
another state to continue processing the rules in that state.

For example, you might want to evaluate each new opportunity and assign it to a specic sales group. You could add
rules in the initial state that transition to states called Government Agencies, Educational Institutions, or Medical
Groups, depending on the industry type of the organization. Those states could contain rules that are unique to
opportunities in the dierent industries.

Functions are also containers for rules. Functions group sets of rules that you want to use in multiple places. You can
set up many separate rules that call the same function, or set of rules, thereby reducing the number of individual rules
you need. When a rule in one state calls a function, all the rules within that function process. After all the rules in the
function process, the rules engine resumes processing in the original state with the next rule in that state.

Note:  The primary dierence between states and functions is what happens when the rules engine processes
the last rule. When the last rule in a state is processed, the rules engine stops processing (unless it encounters
a stop processing rule before the last rule or it transitions to a function or another state). When the last rule
in a function is processed, the rules engine proceeds to the next rule in the state from which the function was
called.

While functions are useful tools for grouping rules, avoiding duplication, and making maintenance easier, you are not
required to use them in a rule base. You can still take advantage of the powerful features of business rules by adding as
many states as you need, based on the processes you want to automate, and then creating rules within each state.

Variables in Business Rules  
A variable is a temporary data item that is assigned a default value at the start of rules processing. The variable can be
modied by rule actions during processing.

Other rules can then use it as a condition for triggering certain actions based on its value. The value of the variable is
not stored in the database, so it returns to its default value the next time the rules engine begins processing.

Note:  A custom eld can be used to accomplish the same function as a variable. If you are deciding whether
to use a custom eld or a variable, ask yourself whether you need the data for future reference. A variable is
temporary, so it returns to the initial value each time the rules engine is run. A custom eld, on the other hand,
is xed. That is, at the end of rules processing, it stores the nal value in the database to be available at the
start of the next round of rules processing for the object.
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Rule variables are useful when you want to accumulate a value and save it conditionally or perform some action based
on the accumulated value. A common example of a variable is a score. You can modify a variable based on whether the
object being evaluated matches rule conditions. Then you can assign dierent actions based on the variable’s value. For
an example of a rule using a variable, see Create a Variable to Measure Service Quality.

See Add or Edit a Variable for the procedure to add or edit a variable.

Variable Data Type Actions

Integer • Set equal to an absolute value.

• Increment by n.

• Decrement by n.

• Set equal to the value of another integer variable or custom eld.

Text Field • Set equal to an absolute string.

• Prepend character string.

• Append character string.

• Set equal to the value of another character variable or custom eld.

See Actions to Set Custom Fields and Variables for information about how leading and trailing spaces
are handled when rule actions are used to set variables.
 

Date Field • Set equal to an absolute value.

• Increment by n days.

• Decrement by n days.

• Set equal to the value of another date variable or custom eld or object date or date/time eld.

Date/Time • Set equal to an absolute value.

• Increment by n days, hours, or minutes.

• Decrement by n days, hours, or minutes.

• Set equal to the value of another date/time variable or custom eld or object date or date/time
eld.

Related Topics
• Create a Rule Base

Rules Processing Order  
All the rules in a state process in the order you specify.

Rules processing for new objects begins in the state you have designated as the initial state. (Existing objects begin in
whatever rule state they were in when they were last updated.) The only way rules other than those in the initial state
process is if rules in that state have actions that transition to another state or call a function. Otherwise, rules processing
for new objects ends when the rules engine reaches the last rule in the initial state.
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Note:  The Oer Advisor rule base is an exception to the requirement for an initial state. Because only one
state—Targets—is permied for this type of rule, this state is the default when you open Oer Advisor rules.
You cannot add states or functions in Oer Advisor rules. See Overview of Oer Advisor Administration.

By default, when rules processing transitions to another state or calls a function, it begins processing all the rules in that
state or function and continues until it reaches the end. However, you can stop processing by adding an action such as
Stop Processing Rules, Transition State and Stop, Transition State and Continue, or Call Function.

Related Topics
• Variables in Business Rules

• Business Rule Actions

• Create a Rule Base

Create a Rule Base  
An object’s rule base includes all the rules, states, functions, and variables associated with that object. The process for
creating a rule base consists of creating all the elements that make up the rule base and includes these main steps.

This process, especially states and functions, does not apply to custom object business rules, which use the new
business rules engine. See Business Rules Engine for the Agent Browser UI for more information.

1. Open the Rules editor and select the object type of the rule base (answer, contact, incident, chat, opportunity,
organization, task, or Oer Advisor) on the ribbon.

2. Create an initial state for the rule base.
3. Add additional states, functions, and variables as necessary.
4. Add rules to each state and function.
5. Reorder the rules within states and functions as necessary.
6. Activate the rule base.
7. Verify that the rules are performing as expected.

Related Topics
• How to View Rule Bases

• Rules Processing Order

• Variables in Business Rules

• Compilation and Activation of Rule Bases

• Add a Rule

• Verify a Rule Using the Rule Log

Add a State  
This procedure explains how to add a state to the contact rule base. However, the steps are the same for adding states
to any rule base.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click Contact to view active contact rules.

When viewing active rules in a rule base, you see the rules that are currently used to manage contacts or other
records on your site.
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4. Click Edit to enter the edit mode. The rules you see in this mode are not used on your site until you activate
them.

5. Right-click States, then select New State.
6. Enter the name of the state in the State Name eld.

Choose meaningful names for states based on the processes you want to automate. For example, you might
name the initial state Initial or Created, and name other states Updated, Work in Progress, Review, or whatever
best describes the rules within the state.

7. To add a note about the state, enter comments in the Notes eld.
8. To make this state the initial state, select the Initial State check box.

You must have one state (and only one) designated as the initial state before you can compile the rule base.
9. Click Save.

The state appears in the Rules tree.
10. To add more states, repeat this procedure from step 5.

Related Topics
• Compilation and Activation of Rule Bases

Add a Function  
This procedure explains how to add a function to a rule base.

1. While editing a rule base, right-click Functions in the rules tree, then select New Function.
The Functions editor is activated.

2. Enter the name of the function in the Function Name eld. Use a name that identies the performance of the
function, for example, Escalation.

3. To add a note about the function, enter comments in the Notes eld.
After you save the function, you can hover over it in the tree to view the note.

4. Click Save.
The function appears in the tree.

5. To add more functions, repeat these steps.

Add or Edit a Variable  
This procedure describes the steps to add a variable to a business rule or edit an existing one.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click the buon for the rule type to which you want to add the variable.

The incident rule base is selected by default.
4. Click Edit.
5. Do one of these:

◦ Right-click Variables in the Rules tree, then select New Variable.

◦ Right-click a variable, then select Edit Variable.

The editor is activated.
6. Enter the eld information for the rule variable.

Field Description

Rule Variable Name Enter the name of the rule variable in this eld.
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Field Description

Data Type Select the variable data type. The options include Integer, Text Field (to a maximum of
255 characters), Date Field, and Date/Time. After you have saved a variable, you cannot
edit its data type.

Default Enter a value that will be the variable initial value every time the rules engine is invoked
in the rule base.

Notes Enter any note you want to add to the variable. The note will be visible when you hover
over the variable in the tree.

7. Click Save.
8. To delete a variable, right-click it, select Delete Variable, and then conrm that you want to delete the variable.

If the variable you are trying to delete is used in any rule, a variable dependency list shows which rules use
the variable. You must delete the condition or action of any rule using the variable before you can delete the
variable. See Dependency Conicts.

Add a Rule  
After you add states and functions for an object type, you can add rules.

CAUTION:  An extremely high number of complex rules can cause the system to run out of memory and
cause errors. If, for example, you have more than 675 highly complex rules (each with 20 conditions, 20 Then
actions, and 20 Else actions), then memory errors are likely to occur. More than 1,000 rules of moderate
complexity (3 conditions, 5 Then actions, and 3 Else actions) can be run without error, although it might take
more than a minute to save the rule base.

The basic steps for adding a rule are similar for all types of rules, although the condition and action options available
vary by rule type. The procedure shown here uses opportunity rules as an example.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click Opportunity on the ribbon to view active opportunity rules.
4. Click Edit on the ribbon to enter the edit mode.
5. Right-click the state or function to which you want to add the rule, then select New Rule.

The Edit Opportunity Rule window opens.
6. Enter the name of the rule in the Rule Name eld.
7. To add a note about the rule, enter comments in the Notes eld. Add any information or special instructions

that may be helpful when sta members hover over the rule in the Rules tree.
8. To add a condition, click Add IF Condition Based On.

Opportunity rule conditions include Opportunity, Contact, Organization, and Rule Variables (if variables have
been added), each with a drop-down menu containing the elds for the condition. (Rules for other object types
have dierent menus for selecting conditions. See Business Rule Conditions for a description of the conditions
for each object.)

Note:  You might decide you want the rule actions to apply to all opportunities. In that case, you can
create a rule that has only actions, but no conditions. The actions must be added to the Then clause.
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a. Select Opportunity, Contact, Organization, or Rule Variables to display the drop-down menu of elds,
and then select the eld for the condition.
For example, select the Contact eld with the Service State to identify contacts who have entered the
system through customer support.

b. Click Select Operator and select the operator that applies to the eld you selected.
Using the example from the previous step, if the operator is “equals,” dierent operators appear in the
Select Operator drop-down menu when you select dierent elds.

c. Enter the value.
9. To add another condition to the rule, repeat the previous step.

You can require that only one of the conditions be met before the rule action is executed, that all of them are
met, or that some combination is required. To understand the relationships when a rule contains multiple
conditions, see Business Rule Logical Expressions.
In our example, add a second condition using a contact custom eld called “Are you a current customer?”
and set the eld to equal No. This identies customers who have expressed enough interest to call customer
support, but who are not yet contacts.

10. To delete a condition after you have added it to a rule, select the Delete Condition check box.
The editor is refreshed.

11. Click Add Action–Then to choose the action that will be executed if the conditions are met. In this example, the
action is sending an email to a sales manager.

12. Select the To Assignee check box. You will also need to select a sta member or group from the drop down. For
example, to send the opportunity email to Sales, scroll down and select Sales.

13. To add an action to the Else clause, click Add Action–Else and select an action. For example, contacts that do
not match the rule conditions have an Opportunities or Outreach state or are already contacts. In that case, you
might want to add an action that sends these contacts a survey to determine customer satisfaction.

14. To delete an action after adding it to a rule, select the Delete Action check box.
The editor is refreshed.

15. To add more actions to the rule, repeat step 10 or 11, depending on whether you want to add the action to the
Then or the Else clause.

16. Click Save.

139



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Rule validation prevents saving meaningless rules. For example, a rule with no condition automatically executes
the actions in the Then clause. If the rule also contains an Else clause, the rule is invalid because a non-existent
condition cannot be unmatched. Rules with no action are also invalid.
If the rule is successfully saved, it appears in the Rules tree under the appropriate state or function. If the save is
not successful, a message prompts you to replace an invalid value or add a missing value.

Related Topics
• Business Rule Operators

• Business Rule Actions

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks

• Search a Rule Base

Business Rule Conditions  
The conditions of a rule compose its “if” statement. If these conditions are met, then the rules engine performs the
action specied in the rule.

Examples of conditions include “If the contact’s state equals Montana,” “If the incident customer thread contains
‘warranty’,” or “If the forecast for the opportunity is greater than $5,000.” The basic form of a condition is “If [this
object] [has this relationship to] [the basis for comparing the object].”

Tip:  It is not necessary to add conditions to a rule. If, for example, you want the rule action to be applied to all
objects, then simply do not add any condition to the rule.

A condition contains these primary elements:

• Field—The eld is the element you want to consider in the rule. In the previous examples, the elds are state,
customer thread, and forecast. Each type of rule (answer, contact, incident, chat, opportunity, organization,
Oer Advisor, and task) has a set of elds that are used to add conditions for its rules.

• Operator—The operator is the relationship between the eld and the value. In the preceding examples, the
operators are equals, contains, and greater than. The selection of operators varies with the eld. Some are
simply “equals” and “not equals,” while others express more complex relationships.

• Value—The value is the comparison you want to make with the eld. In the examples, the values are Montana,
warranty, and $5,000. The format of the value changes, depending on the eld. You might select a menu
option, enter a string of text, or select a check box or option to dene the value.

The elds are organized according to their type. In the rst example (“If the contact’s state equals Montana”), the
state eld is a contact eld. The second example has the eld customer thread, which is an incident eld, and the third
example eld, forecast, is an opportunity eld.

When you click Add IF Condition Based On, a list of eld types specic to the type of rule appears, each with a drop-
down menu of the available elds. For example, contact rules let you select Contact and Organization elds, while
incident rules let you select Incident, Contact, and Organization elds.

Rule Base Field Types

Answer Answers

Chat • Incident

• Contact
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Rule Base Field Types

• Organization

Contact • Contact

• Organization

Incident • Incident

• Contact

• Organization

Opportunity • Opportunity

• Contact

• Organization

Organization Organization

Oer Advisor • Incident

• Contact

• Organization

• Purchased Products

Task • Tasks

• Opportunity

• Incident

• Answers

• Contact

• Organization

Some conditions depend on how you have congured your site. Customizable menu items, such as products,
categories, and dispositions, appear as conditions only if they have been added. If the rules engine does not detect the
presence of customizable menu items, custom elds, and other items, such as SLAs, mailboxes, Outreach emails and
mailings, and Feedback surveys, they do not appear in the list of conditions. If you add them while you create rules, you
must close the Rules editor and reopen it for them to display.

Note:  You can add items to a customizable menu that already has items in it without needing to close the
Rules editor for them to be visible.

In addition to the elds that are specic to each type of rule, all rules can use rule variables for rule conditions. If no
variables have been dened in the rule base, the Rule Variables eld type is disabled.
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Related Topics
• Business Rule Operators

• Custom Fields and Masks in Conditions

• Previous Fields in Conditions

• Conditions for Each Rule Base

• Add a Rule

Relative Time Conditions  
Relative time calculates the number of minutes or hours from the current time or from a specic event, such as time
created or time updated.

Several rule conditions let you select a date and time. For example, you might want to add a rule with the condition “If
the task due date is within the range from April 1 to April 30.” The following conditions allow date/time selection.

• Banner Updated for answers, contacts, incidents, opportunities, and organizations

• Acquired and Created for contact rules

• Created, Updated, Initial Contact, Forecast Close, Date Closed, Lost Date, and Recall for opportunity rules

• Acquired for organization rules

• Purchased Products Date Purchased for Oer Advisor rules

• Completed Date, Created, Updated, Due Date, Planned Completion Date, and Start Date for task rules

The ability to set a condition based on a specic date and time (whether that date/time value is before, after, equal to,
or within a range you specify) is a useful tool. However, there may be times when you want to set a relative date/time
value. For example, you may want a condition “If the task due date is less than 8 hours from now.” In that case, you can
select a relative time for the rule condition. Relative time calculates the number of minutes or hours from the current
time or from a specic event, such as time created or time updated.

See Select the Relative Time Condition Using a Task Due Date to set a relative time condition using a task due date, but
the procedure is the same for seing other relative time conditions.

Related Topics
• Business Rule Conditions

Select the Relative Time Condition Using a Task Due Date  
The following procedure shows you how to set a relative time condition using a task due date, but the procedure is the
same for seing other relative time conditions.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click Task on the ribbon.
4. Click Edit on the ribbon.
5. Right-click the rule you want to add the relative time condition to, then select Edit.
6. Click Add IF Condition Based On, then select  Tasks > Due Date . In this example, assume you want to send a

reminder email to sta members who have tasks due within the next eight hours.
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7. Select the Relative check box to set the condition based on a time relative to the task due date.
8. Click the drop-down menu above the Relative check box.

The Relative Time window opens.
9. Complete the elds in the Relative Time window.

a. Click the Direction drop-down menu, then select + (Future).
b. Enter 8 in the Oset eld.
c. Click the Unit drop-down menu, then select Hours.
d. Click Save to save your seings and close the Relative Time window.

10. Click the drop-down menu next to the condition Relative check box, then select what you want the time you
specied in step 9 to be compared.
For example, if you wanted the rule to be triggered eight hours after a task is created, you could select
Tasks.Created from the menu. In our example, you can leave the menu set to the default value of “Now,”
because you want this rule to be triggered eight hours after any event occurs that causes the rule to be checked
(such as when a task is edited).

11. Click the Select Operator drop-down menu, then select Less Than.
In this example, we want the rule to be triggered when a task due date is less (earlier) than the relative time we
specied.

With this type of condition, you must add an action before you can save the rule. See Business Rule Actions.

Custom Fields and Masks in Conditions  
Before reviewing the conditions for each type of rule, it is important to understand how custom elds are handled and
how to enter conditions for elds that use masks.

If you have added custom elds for contacts, organizations, incidents, answers, or opportunities, they will appear in the
condition drop-down menu.

Some elds have masks that let you dene a format for a eld to ensure that sta members enter them correctly. For
example, you might want to dene a custom eld for a catalog number that uses a mask to force the correct sequence
of leers, numbers, and formaing characters.

When you add a condition for any eld that uses a mask, you must omit the formaing characters when you enter
the value for that condition. For example, if you add a custom eld with the ULF-M#M#, the entered data consists of
an uppercase alphabetic character, a hyphen, and two numbers, such as M-63. If you want to create a rule using the
custom eld as a condition, the value for the condition must be “M63” and not “M-63” with the hyphen.

Previous Fields in Conditions  
Previous elds let you detect changes that occur to the elds.

Many conditions have “Previous” elds, including, for example, Previous Status, Previous Escalation Level, Previous
Assigned, Previous Group, and Previous Strategy Hierarchy. These elds all contain the value currently stored in the
database. The eld reects the value when the object is added or updated or when rules processing begins.

Conditions for Each Rule Base  
See the linked topics listed here to view the tables associated with each type of rule base.
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In each table, the rst column lists the eld, the second column describes what the eld refers to, and the third column
describes how to select the value, based on its format. For example, formats might include text that you type or a menu
option you select.

Note:  When the format of a value consists of menu selections, you can choose multiple options by pressing
Ctrl while making each selection. Or if the value displays check boxes, you can make multiple selections.

Some conditions depend on how you have congured your site. Customizable menu items, such as products,
categories, and dispositions, appear as conditions only if they have been added. If the rules engine does not detect the
presence of customizable menu items, custom elds, and other items, such as SLAs, mailboxes, Outreach emails and
mailings, and Feedback surveys, they do not appear in the list of conditions. If you add them while you create rules, you
must close the Rules editor and reopen it in order for them to display.

Note:  You can add items to a customizable menu that already has items in it without needing to close the
Rules editor for them to be visible.

In addition to the elds that are specic to each type of rule, all rules can use rule variables for rule conditions. If no
variables have been dened in the rule base, the Rule Variables eld type is disabled.

See these topics for condition eld details:

• Answer Conditions

• Contact Conditions

• Incident Conditions

• Opportunity Conditions

• Organization Conditions

• Purchased Products Conditions for Oer Advisor Rules

• Task Conditions

Related Topics
• Business Rule Conditions

Answer Conditions  
When choosing answer conditions, select from these elds and enter the value in the specied format.

Field Description Selecting the Value

Answer Access Answer’s access level. Select an access level from the
menu.

Status Answer’s status. Select a status from the menu.

Previous Status Answer’s previous status. Select a status from the menu.

Assigned Sta account in the answer’s
Assigned eld.

Select a sta account from the
menu.

Group Group in the answer’s Assigned
eld.

Select a group from the menu.
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Field Description Selecting the Value

Previous Assigned Answer’s previous assigned sta
account.

Select a sta account from the
menu.

Previous Group Answer’s previous group. Select a group from the menu.

Language Selected language installed from
a language pack.

Select a language from the menu.

Escalation Level Answer’s escalation level.
This eld is set through rules
in the database and cannot be
edited in the record. To view an
answer’s escalation level, click the
Info buon on the ribbon when
the answer is open.
 

Select an escalation level from
the menu.

Previous Escalation Level Answer’s previous escalation
level.

Select an escalation level from
the menu.

Updated From Source of the most recent answer
update.

Select the check box that
indicates where the answer was
most recently updated.

Banner Note Information entered by a sta
member in the banner.

Enter text in the eld.

Banner Flag Importance of the banner. Select an importance level from
the menu.

Banner Updated Date and time the banner was
last updated.

Click the drop-down menu
to open the current month’s
calendar, then select a date and
time the banner was updated. Or
select a relative time.

Banner Updated By Sta member who last updated
the banner.

Select a sta member from the
menu.

Product Products added on the Products/
Categories/Disposition editor.

Select the appropriate product
check boxes.

Category Categories added on the
Products/Categories/Disposition
editor.

Select the appropriate category
check boxes.

Contact Conditions  
When choosing contact conditions, select from these elds and enter the value in the specied format.

Field Description Value Format

Last Name Contact’s last name. Enter text in the eld.

First Name Contact’s rst name. Enter text in the eld.

Source Source of the contact. Select the check box for the
source of the contact.
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Field Description Value Format

Updated From Source of the most recent contact update. Select the check box that
indicates where the contact was
most recently updated.

Email–Primary Contact’s email address. Enter text in the eld.
The maximum number of
characters allowed in this eld
is 80.
 

Email–Primary Invalid Whether the contact’s primary email
address is determined to be invalid as a
result of bounced email processing.

Select Yes or No.

Email–Alternate #1 Alternate email address. Enter text in the eld.
The maximum number of
characters allowed in this eld
is 80.
 

Email–Alternate #1 Invalid Whether the contact’s rst alternate email
address is determined to be invalid as a
result of bounced email processing.

Select Yes or No.

Email–Alternate #2 Second alternate email address. Enter text in the eld.
The maximum number of
characters allowed in this eld
is 80.
 

Email–Alternate #2 Invalid Whether the contact’s second alternate
email address is determined to be invalid as
a result of bounced email processing.

Select Yes or No.

Login Contact’s user ID. Enter text in the eld.

Contact Type Any contact type you have added. Select a contact type from the
menu.

Marketing Organization
Name

The name of the organization as it is used
by Outreach.

Enter text in the eld.

Street Contact’s street address. Enter text in the eld.

City Contact’s city. Enter text in the eld.

State/Province Contact’s state or province. Select a state or province from
the menu.

Country Contact’s country. Select a country from the
menu.

Postal Code Contact’s postal code. Enter text in the eld.

Oce Phone Contact’s oce phone number. Enter text in the eld using
any formaing characters that
appear in the record.

Oce Phone (Unformaed) Contact’s oce phone number regardless
of formaing characters.

Enter a numeric string in the
eld.
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Field Description Value Format

Mobile Phone Contact’s mobile phone number. Enter text in the eld using
any formaing characters that
appear in the record.

Mobile Phone
(Unformaed)

Contact’s mobile phone number regardless
of formaing characters.

Enter a numeric string in the
eld.

Fax Phone Contact’s fax number. Enter text in the eld using
any formaing characters that
appear in the record.

Assistant Phone Phone number for the contact’s assistant. Enter text in the eld using
any formaing characters that
appear in the record.

Assistant Phone
(Unformaed)

Contact’s assistant’s oce phone number
regardless of formaing characters.

Enter a numeric string in the
eld.

Home Phone Contact’s home phone number. Enter text in the eld using
any formaing characters that
appear in the record.

Home Phone (Unformaed) Contact’s home phone number regardless
of formaing characters.

Enter a numeric string in the
eld.

Service State Service check box selection for the State. Select Yes or No.

Opportunities State Opportunity Tracking check box selection
for the State.

Select Yes or No.

Outreach State Outreach check box selection for the State. Select Yes or No.

Disabled Disabled Flag status on the contact record. Select Yes or No.

Global Opt-in Contact’s decision to receive mailings. Select the Yes or No option.

Survey Opt-in Contact’s decision to participate in surveys. Select Yes or No.

Email Format Preference Contact’s preference for email format (text,
 HTML, multipart, or unspecied).

Select a mail type from the
menu.

Acquired Date the contact was acquired as a
customer.

Click the drop-down menu
to open the current month
calendar, then select a date the
contact was acquired. Use the
arrows at the top to change the
month if necessary.

Created Date the contact record was created. Click the drop-down menu
to open the current month
calendar, then select a date the
contact was acquired.

Banner Note Information entered by a sta member in
the banner.

Enter text in the eld.

Banner Flag Importance of the banner. Select an importance level from
the menu.

Banner Updated Date and time the banner was last updated. Click the drop-down menu
to open the current month
calendar, then select a date and
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Field Description Value Format

time the banner was updated.
Or select a relative time.

Banner Updated By Sta member who last updated the banner. Select a sta member from the
menu.

Incident Conditions  
When choosing incident conditions, select from these elds and enter the value in the specied format.

Incident rules use all elds with the exception of Chat Queue ID. Fields used by the other rule types (chat, Oer Advisor,
and task rules) are indicated in the eld descriptions.

Field Description Value Format

Customer Thread All customer threads in the incident. Enter text in the eld.

Sta Thread All sta response threads in the incident. Enter text in the eld.

Proposed Response Incident Proposed Response eld
(uncommied response thread).

Enter text in the eld.

Reference # Incident Reference # eld. (Also used in
task rules.)

Enter text in the eld.

Subject Subject of an incoming email or incident.
This also refers to the Subject eld on the
Ask a Question page or API incident source.
(Also used in task rules.)

Enter text in the eld.

Status Incident status. (Also used in task rules.) Select a status from the menu.

Previous Status Incident previous status. Select a status from the menu.

Previous Assigned Sta member previously assigned to the
incident.

Select a sta account from the
menu.

Previous Group Group previously assigned to the incident. Select a group from the menu.

Channel Source of an incoming incident or outgoing
response. Channels are grouped as
standard email channels (CSS Email, MA
Email, Phone, Fax, Post, CSS Web, MA
Web, Chat, and Email) and social channels
(community, Twier, YouTube, RSS feeds,
 and Facebook).

Select a channel from the
menu.

Created By Sta member who added the incident.
(Also used in task rules.)

Select a sta account from the
menu.

Assigned Sta member assigned to the incident.
(Also used in task rules.)

Select a sta account from the
menu.

Product Products added on the Products/
Categories/Dispositions editor. (Also used
in chat, Oer Advisor, and task rules.)

Select the appropriate product
check boxes.
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Field Description Value Format

Category Categories added on the Products/
Categories/Dispositions editor. (Also used
in chat, Oer Advisor, and task rules.)

Select the appropriate category
check boxes.

Disposition Dispositions added on the Products/
Categories/Dispositions editor. (Also used
in task rules.)

Select a disposition from the
menu.

Language Selected language installed from a
language pack. (Also used in chat and task
rules.)

Select a language from the
menu.

Created Time the incident was added. Enter text in the eld using the
format hh:mm or use the up or
down arrows to scroll to a time.
This condition can use the
unique “in/not in response
interval” operators.
 

Group Group assigned to the incident. (Also used
in task rules.)

Select a group from the menu.

Interface Interface of the Ask a Question, incident,
 or API incident source. (Also used in chat,
 Oer Advisor, and task rules.)

Select an interface from the
menu.
Use this eld to apply a rule to a
specic interface.
 

Mailbox Service and Outreach mailboxes that have
outgoing email enabled. (Also used in task
rules.)

Select a mailbox from the
menu.

Customer SmartSense SmartSense rating calculated for all
customer threads in the incident.

Select a SmartSense rating
from the menu.

Sta SmartSense SmartSense rating calculated for all sta
response threads in the incident.

Select a SmartSense rating
from the menu.

Email Header Text in the header of an email that adds an
incident.
EGW_SAVE_EMAIL_HEADERS
(RightNow Common/Service
Modules/Oracle Email) must be
enabled for this condition to appear on the
drop-down menu.
 
Only current header information is available
for rules processing. If the incident header
is updated by an agent or customer, the
original header information is no longer
available. (Also used in task rules.)
 

Enter text in the eld.

Source Source of the incident. Select the check box for the
source of the incident.

Updated From Source of the most recent incident update. Select the check box that
indicates where the incident
was most recently updated.
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Field Description Value Format

Escalation Level Incident escalation level. (Also used in task
rules.)
This eld is set through rules in the
database and cannot be edited in the
record. To view an incident escalation level,
click the Info buon on the ribbon when the
incident is open.
 

Select an escalation level from
the menu.

Previous Escalation Level Incident previous escalation level. Select an escalation level from
the menu.

Queue ID Incident assigned queue. (Also used in task
rules.)

Select a queue ID from the
menu.

Mailing ID Mailing that prompted a response, thereby
adding the incident.
This eld appears only if you have created
mailings in Outreach. (Also used in task
rules.)
 

Select a mailing from the menu.

Response Sent Agent selection in the Send Response
check box when solving the incident.

Select the Yes or No option.

Last Survey Score Score from the most recent survey
associated with this incident. (Also used in
task rules.)

Enter a numerical value in the
eld.

Severity Incident severity. (Also used in task rules.) Select an incident severity
option from the menu.

Banner Note Information entered by a sta member in
the banner.

Enter text in the eld.

Banner Flag Importance of the banner. Select an importance level from
the menu.

Banner Updated Date and time the banner was last updated. Click the drop-down menu
to open the current month
calendar, then select a date and
time the banner was updated.
Or select a relative time.

Banner Updated By Sta member who last updated the banner. Select a sta member from the
menu.

Incoming Mailbox Service and Outreach mailboxes that have
incoming email enabled.

Select a mailbox from the
menu.

SLA Instance ID SLA that has been applied to the incident. Select an SLA from the menu.

Chat Queue ID Incident queues for chat rules. Select a Chat Queue ID from
the menu.
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Related Topics
• Overview of Multiple Interfaces

• SmartSense

• Overview of Mailings

• Add or Edit an Incident Queue

• Add or Edit an Incident Severity Level

Opportunity Conditions  
When choosing opportunity conditions, select from these elds and enter the value in the specied format.

Field Description Value Format

Status Opportunity status (lead, reject, active,
 closed, lost, inactive, dead, or unspecied).

Select a status from the menu.

Previous Status Opportunity previous status. Select a status from the menu.

Escalation Level Opportunity escalation level.
This eld is set through rules in the
database and cannot be edited in the
record. To view an opportunity’s escalation
level, click the Info buon when the
opportunity is open.
 

Select an escalation level from
the menu.

Previous Escalation Level Opportunity previous escalation level. Select an escalation level from
the menu.

Assign Sta member assigned to the opportunity. Select a sta account from the
menu.

Previous Assigned Sta member previously assigned to the
opportunity.

Select a sta account from the
menu.

Interface Interface where the opportunity was added. Select an interface from the
menu.

Name The name of the opportunity. Enter text in the eld.

Source Source of the opportunity. Select a check box for the
source of the opportunity.

Updated From Source of the most recent opportunity
update.

Select the check box that
indicates where the opportunity
was most recently updated.

Strategy Hierarchy Strategy hierarchy for the opportunity. Select a check box for the
opportunity strategy hierarchy.

Previous Strategy Hierarchy Opportunity previous strategy hierarchy. Select a check box for the
opportunity previous strategy
hierarchy.

Created Date and time the opportunity was added. Click the drop-down menu
to open the current month
calendar, then select a Created
date.
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Field Description Value Format

Use the arrows at the top to
change the month if necessary.
 

Created By Sta member who added the opportunity. Select a sta account from the
menu.

Updated Date and time the opportunity was
updated.

Click the drop-down menu
to open the current month
calendar, then select an
Updated date. Or select a
relative time.

Updated By Sta member who updated the
opportunity.

Select a sta account from the
menu.

Manager Forecast Manager forecast for the opportunity. Click the drop-down menu and
enter a value in the Amount
eld.
Click the Currency drop-down
menu, then select the currency.
 

Manager Forecast
Commied

Yes or No selection in the Manager Commit
eld.

Select Yes or No.

Rep Forecast Sales representative’s forecast for the
opportunity.

Click the drop-down menu and
enter a value in the Amount
eld.
Click the Currency drop-down
menu, then select the currency.
 

Rep Forecast Commied Yes or No selection in the Rep Commit eld. Select Yes or No.

Closed Value Value the opportunity closed at. Click the drop-down menu and
enter a value in the Amount
eld.
Click the Currency drop-down
menu, then select the currency.
 

Summary Information entered in the Summary text
eld of the opportunity.

Enter text in the eld.

Territory Territory for the opportunity. Select a check box for the
opportunity territory.

Initial Contact Date of the opportunity initial contact. Click the drop-down menu
to open the current month
calendar, then select the date of
initial contact.

Forecast Close Date the opportunity is forecasted to close. Click the drop-down menu
to open the current month
calendar, then select a date
when the opportunity is
forecasted to close.

Date Closed Date the opportunity closed. Click the drop-down menu
to open the current month
calendar, then select a date
when the opportunity closed.
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Field Description Value Format

Cost of Sale Total cost of a sale. Click the drop-down menu and
enter a value in the Amount
eld.
Click the Currency drop-down
menu, then select the currency.
 

Returned Value Value of products returned by a customer. Click the drop-down menu and
enter a value in the Amount
eld.
Click the Currency drop-down
menu, then select the currency.
 

Last Survey Score Score from the most recent survey
associated with this opportunity.

Enter a numerical value in the
eld.

Lost Date Date the opportunity status was set to Lost. Click the drop-down menu
to open the current month
calendar, then select the date
when the opportunity was lost.

Recall Date the contact for the opportunity should
be called again.

Click the drop-down menu
to open the current month
calendar, then select the date
for calling the contact for the
opportunity.

Lead Rejection Lead rejection reason selected by the sta
member for the opportunity.

Select a lead rejection reason
from the menu.

Lead Rejection Description Text stored in the lead rejection reason eld
in the opportunity.

Enter text in the eld.

Win/Loss Factor Win/loss factor selected by the sta
member for the opportunity.

Select a win/loss factor from
the menu.

Win/Loss Description Text entered as the win/loss description in
the opportunity.

Enter text in the eld.

Banner Note Information entered by a sta member in
the banner.

Enter text in the eld.

Banner Flag Importance of the banner. Select an importance level from
the menu.

Banner Updated Date and time the banner was last updated. Click the drop-down menu
to open the current month
calendar, then select a date and
time the banner was updated.
Or select a relative time.

Banner Updated By Sta member who last updated the banner. Select a sta member from the
menu.

153



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Related Topics
• Add or Edit a Strategy

• Add or Edit a Territory or Subterritory

• Add or Edit a Lead Rejection Type

• Add or Edit a Win/Loss Reason

Organization Conditions  
When choosing organization conditions, select from these elds and enter the value in the specied format.

Note:  Two default organization address types are included by default: Billing and Shipping. When selecting
the Street, City, State/Province, Country, and Postal Code elds under Organization, you can see separate
entries for each address type, as well as for any custom organization address types that have been added. See
Add or Edit an Organization Address Type.

Field Description Value Format

Organization Name Name of the organization. Enter text in the eld.

Source Source of the organization. Select the check box for the
source of the organization.

Updated From Source of the most recent contact update. Select the check box
that indicates where the
organization was most recently
updated.

Street Organization street address. Enter text in the eld.

City Organization city. Enter text in the eld.

State/Province Organization state or province. Select a state or province from
the menu.

Country Organization country. Select a country from the
menu.

Postal Code Organization’s postal code. Enter text in the eld.

Service State Service check box selection for the State. Select Yes or No.

Opportunities State Opportunity Tracking check box selection
for the State.

Select Yes or No.

Outreach State Outreach check box selection for the State. Select Yes or No.

Industry Type Organization industry. Select an industry type from
the menu.

Acquired Date the organization was acquired as a
customer.

Click the drop-down menu
to open the current month
calendar, then select a date the
organization was acquired.
Use the arrows at the top to
change the month if necessary.
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Field Description Value Format

Banner Note Information entered by a sta member in
the banner.

Enter text in the eld.

Banner Flag Importance of the banner. Select an importance level from
the menu.

Banner Updated Date and time the banner was last updated. Click the drop-down menu
to open the current month
calendar and select a date and
time the banner was updated.
Or select a relative time.

Banner Updated By Sta member who last updated the banner. Select a sta member from the
menu.

Purchased Products Conditions for Oer Advisor Rules  
When choosing conditions for an Oer Advisor rule, select from the elds described in the following table and enter the
value in the specied format.

Oer Advisor rules have a single purpose: to dene targets—that is, groups of customers—that meet the conditions you
specify. Regardless of the condition you select, the default action is always “Contact will match this target.”

In addition to incident, contact, and organization conditions for Oer Advisor rules, you can also select a unique
Purchased Products condition. This condition is a combination of three conditions, all of which must be met by a
purchased product entry in order for the Purchased Products condition to be met. These criteria are product, price, and
date purchased.

Note:  Oer Advisor must be enabled on your site for this object type to appear. Contact your Oracle account
manager.

The following table describes the condition elds available for purchased products and how to select the value based on
its format.

Field Description Value Format

Product Sales products purchased by the customer. Select a product from the
menu.

Price The dollar value of a customer’s purchases. Click the drop-down menu and
enter a value in the Amount
eld. Click the Currency drop-
down menu and select the
currency.

Date Purchased The date of a customer’s purchases. Click the drop-down menu
to open the current month
calendar and select a purchase
date. Use the arrows at the
top to change the month if
necessary.
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Related Topics
• Add or Edit a Sales Product

Task Conditions  
When choosing task conditions, select from these elds and enter the value in the specied format.

Field Description Value

Status Task status. Select a status from the menu.

Previous Status Task previous status. Select a status from the menu.

Assign Sta member to assign the task. Select a sta account from the
drop-down menu.

Previous Assigned Sta member previously assigned the task. Select a sta account from the
menu.

Completed Date Date the task was completed. Click the drop-down menu
to open the current month
calendar, then select a task
completion date.
Use the arrows at the top to
change the month if necessary.
 

Created Date the task was added. Click the drop-down menu
to open the current month
calendar, then select the date
the task was added.

Updated Date the task was last updated. Click the drop-down menu
to open the current month
calendar, then select the date
the task was updated.

Updated From Source of the most recent task update. Select the check box that
indicates where the task was
most recently updated.

Due Date Date the task is due. Click the drop-down menu
to open the current month
calendar, then select the task’s
due date.

Escalation Level Task escalation level.
This eld is set through rules in the
database and cannot be edited in the
record. To view a task escalation level, click
Info on the ribbon when the task is open.
 

Select an escalation level from
the menu.

Previous Escalation Level Task previous escalation level. Select an escalation level from
the menu.

Name Name of the task. Enter the task name in the eld.

Percent Complete Percentage of the task that is complete. Enter a value in the eld.
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Field Description Value

Planned Completion Date Date the task is scheduled to be completed. Click the drop-down menu
to open the current month
calendar, then select the
planned completion date for
the task.

Priority Task priority. Select a priority from the menu.

Start Date Date the task is started. Click the drop-down menu
to open the current month
calendar, then select a start
date for the task.

Type Type of task, which means the type of
record the task is associated with.

Select a task type from the
menu.

Business Rule Operators  
An operator expresses the relationship between a condition eld and its value, determining how the eld is applied to
the value of the condition.

For example, in the condition “If an answer assignment equals customer support,” the operator is “equals.” Each
eld has its own set of operators, depending on what is logical for that eld. A rule with the condition “If an answer
assignment is greater than or equal to customer support,” for example, has no relevance and cannot be applied to an
answer.

Operator Description

equals The eld matches the value exactly, including case.

not equals The eld does not match the value.

is null The eld does not contain a value.

is not null The eld contains a value.

less than The eld is less than the value.

less than or equal to The eld is less than or equal to the value.

greater than The eld is greater than the value.

greater than or equal to The eld is greater than or equal to the value.

in range The eld is within the range you specify. You must indicate a beginning and ending value when you
select this operator.

not in range The eld is not within the range you specify. You must indicate a beginning and ending value when you
select this operator.

contains The eld matches only text string values.
This operator uses word stemming, but only in the Summary eld, Subject eld, and incident threads.
Stemmed searches are not case sensitive.
 
For example, if you want the rule to apply to dierent forms of a word, such as singular, plural, or a
dierent verb tense, select “contains” and enter the singular form as the value. When you include
multiple words in the value, the rule applies when the text strings contain all the words, which do not
have to occur sequentially.
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Operator Description

 

does not contain The eld does not contain the text string in the value.
This operator uses word stemming, but only in the Summary eld, Subject eld, and incident threads.
Stemmed searches are not case sensitive. Word stemming is not supported for custom elds, only text
strings.
 

matches regular expression The eld matches the regular expression entered in a text string value.
The regular expression compiler validates the expression. If an error code is returned, the rule is not
saved.
 

does not match regular expression The eld does not match the regular expression entered in a text string value.
The regular expression compiler validates the expression. If an error code is returned, the rule is not
saved.
 

in response interval This operator is used only with the Incident Created condition for incident rules to indicate that the
incident was added within normal working hours.
That is, the incident was added within the response requirements of the SLA associated with the
incident or within the default response requirements if no SLA is associated with the incident. The data
in the condition’s hh:mm eld is not used when this operator is selected.
 

not in response interval This operator is used only with the Incident Created condition for incident rules to indicate that the
incident was not added within normal working hours.
That is, the incident was added outside the response requirements of the SLA associated with the
incident or outside the default response requirements if no SLA is associated with the incident. The
data in the condition hh:mm eld is not used when this operator is selected.
 

modied this edit This operator indicates that the eld value has been changed during the current edit of the object.
This change can occur manually as a result of sta member or customer edits or automatically through
a utility or rule action. All values use this operator.
 

not modied this edit This operator indicates that the eld value was not changed during the current edit of the object. All
values use this operator.

Related Topics
• Regular Expressions

• Add a Rule

Business Rule Logical Expressions  
Logical expressions use AND (&) and OR (|) to dene the relationship between rule conditions.

To edit the logical expression after you have dened conditions, click in the Logical Expressions eld and make the
changes. Use logical expressions when you want to link the conditions in the following ways:

• You want all conditions to apply in order for the rule to initiate its action. Use AND (&) to link the conditions. The
expression 1 & 2 & 3 means that the rule action occurs only when all three conditions are met. Because the
default logical expression is AND, it is not necessary to use a logical expression when you want all conditions to
apply. If you delete the logical expression in this case, the conditions remain linked by AND.
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• You want any one of the conditions to apply in order for the rule to initiate action. Use OR (|) to link the
conditions. The expression 1 | 2 | 3 means that the rule action occurs if any one of the three conditions are
met.

• You want to group the conditions. Using parentheses, you can create an expression such as 1 & (2 | 3). This
expression requires that condition 1 be met and that either condition 2 or condition 3 must also be met. If you
do not use parentheses, AND always has precedence over OR, which determines the order of execution. In that
case, 1 & 2 | 3 requires that both conditions 1 and 2 be met or that condition 3 be met.

Related Topics
• Add a Rule

Business Rule Actions  
The condition is the “if” part of a rule “if-then” statement, and the action is the “then” part. The action species what
occurs to the object (answer, contact, incident, chat, opportunity, organization, target, or task) when the condition is
met.

Actions are also used in the optional Else clause when you want to specify what happens when the object does not
match the rule conditions. Every action that is available in an object Then clause is also available in the Else clause.

Note:  An action that can only be used once in the Then clause (for example, seing an incident status) is also
restricted to a single use in the Else clause, although you can use the same action in both clauses of a rule.

Before you dene actions for rules, review these considerations:

• Action Execution

• Action Order

• Dependency Conicts—If you delete an email or survey that is used in a Send action in a contact, incident, or
opportunity rule, you can still activate the rule base but the rules engine will not process the action. No error
will be logged to indicate that the mailing or survey was not sent.

• Actions to Set Custom Fields and Variables

• Actions for Rule Bases

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks—You dene the conditions that will
schedule an object escalation and what actions you want to occur when that escalation level is reached.

Related Topics
• Add a Rule

Action Execution  
The rules engine can execute actions immediately when a record is saved, or it can defer the action until a later time.

All actions that modify an object (answer, contact, incident, chat, opportunity, organization, target, or task) are executed
immediately upon saving the record. For example, an action can change the status of an incident, set an answer access
level, or set a custom eld. These actions are executed before the next condition is evaluated. Actions that transition to
another state or function or those that stop processing are also executed immediately.

All other actions are passed to the API as deferred actions. Some of these delayed actions are executed immediately
after the rules engine nishes processing, while others are agged to be handled later. Examples of actions that
are executed immediately after rules processing include applying SLA instances and sending email. Events such as
escalation are scheduled to be handled later.
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You must select an object event handler from the Execute Object Event Handler drop-down menu to trigger an external
event action. For objects to display in the Execute Object Event Handler drop-down menu, they must be added on the
process designer and then the process model must be deployed. See Object Event Handlers.

Note:  External events have been deprecated and might be permanently removed in a future release. The
Execute External Event option was disabled in the February 2015 release.

When business rules are triggered (by adding or updating an object), the rules engine processes every rule in the initial
state, and continues processing until it reaches the last rule, regardless of how many rules have already been matched.
Unless otherwise directed, the rules engine processes only the rules in the initial state. To process rules in other states
or functions, you must set an action for one or more rules in the initial state to transition to another state or function.

These actions are available for all rule bases (assuming that additional states and functions exist to be transitioned to):

• Stop Processing Rules—Stops processing, regardless of how many rules remain in the state. Use this action
when you do not want the object compared to any more rules in this or any other state. When you select the
Stop Processing Rules action, the rules engine stops evaluating the object against the rules base. However,
the action does not prevent future processing of the object. When the object is updated, the rules engine will
process it again. If you want to prevent the object from being processed in future updates, create a state that
has no rules and transition the object into it.

• Call Function—Transitions to the function you specify and processes the rules in the function. After the actions
in the function rules are executed, control returns to the next action in the rule that called the function. If you
call a function that contains a rule with either an action to stop processing or to transition to another state, the
rules engine never returns to the rule that called the function.

For example, assume the calling rule contains two actions in this order:

a. Call a function containing a rule with a stop-processing action.
b. Assign the incident to a specic queue.

In this example, the queue assignment is never made because the prior action stopped processing.

• Transition State and Stop—Transitions to the state you specify and stops processing. Use this action when you
want the object moved from one state to another, such as from the Created state to the Updated state, but you
do not want processing to continue. In eect, you are seing up the object for the next edit so rules processing
starts at the appropriate state. For example, depending on your business process, you may want to set up a
separate state for incidents that have been updated so they do not continue to be compared to rules in the
initial state.

• Transition State and Continue—Transitions to the state you specify and continues processing all the rules
in that state until all of those rules process (unless you add another action to stop processing, transition to
another state, or call a function). Use this action when you want the object to continue to be compared to the
rules in the state you transition to.

You can add certain actions without selecting a value. With this functionality, the rule actions are consistent with values
that can be set to No Value in records. For example, you can save an incident without assigning it to a sta member (by
selecting the No Value option). Actions that can be added without selecting a value (that is, the value is set to No Value)
include:

• Set Product

• Set Category

• Set Disposition

• Set Mailbox
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• Set Assigned

• Set Queue

Note:  You must assign a value to any required eld. For example, if products and categories are required, you
cannot select a No Value option to the Set Product action in a rule.

Related Topics
• Business Rule Actions

Action Order  
In general, the order of rule actions is unimportant. The exceptions are the Append Thread actions and the Do Not Send
Response action.

Append Thread actions depend on order because the appended information is added to the outgoing email response in
the same order that the rule actions occur in the rule.

The following Append Thread to Response actions are added to the response thread in the order that you specify in the
rule actions, so that you can eectively format the outgoing email response:

• Append Response Template to Response Field

• Append Existing Solution (by Answer ID) to Response Field

• Append SmartAssistant Response to Response Field

Note:  If the Append Response to the Uncommied Response Buer action is used in conjunction with
multiple Append Thread actions, all appended items are added to the uncommied response rather than the
incident thread. This does not apply to the Append Response Template to Notes Field action.

The Do Not Send Response action is used to prevent automatic incident update responses if you use a message system
outside of Oracle Service Cloud to deliver your responses. The Do Not Send Response action should always be added as
the last rule to ensure that it is applied to all responses. If it does not execute last, another rule could request a response
causing an automatic response through Oracle Service Cloud.

Related Topics
• Business Rule Actions

Actions to Set Custom Fields and Variables  
You can dene rule actions that set custom elds and variables.

When a custom eld or variable has a text eld data type or a custom eld has a text area data type, you can create a
rule to perform any of the following actions on the custom eld or variable:

• Set equal to a literal text string

• Prepend with a literal text string

• Append with a literal text string

• Set equal to the value of another custom eld or variable

When you enter a text string, the system removes any leading or trailing spaces before it inserts the custom eld or
variable in the database. For example, if you set a custom eld to the value hello, and add an action that appends the
word there to the same eld, then the resulting value will be hellothere.
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To create spaces between the words, use quotation marks. In this example, set the custom eld to “hello” and append “
there” (with a space before the t in there) to get the result hello there.

Note:  The quotation marks are removed in the result. The quotation marks at the beginning and end of a
string are removed, but any quotation marks that are embedded in the string will remain in the string.

Related Topics
• Business Rule Actions

Actions for Rule Bases  
This topic contains descriptions of the actions available for rules within each object type.

The available actions depend on the rule object type. These four actions, available in all rule bases and described in
Action Execution, are not included in these tables.

• Stop Processing Rules

• Call Function

• Transition State and Stop

• Transition State and Continue

Some actions depend on items you have added. This includes customizable menu items, such as products, categories,
and dispositions, as well as custom elds, SLAs, mailboxes, Outreach emails and mailings, and Feedback surveys. If you
have not entered any menu options for incident severity, for example, “Severity” will not appear as an action for incident
rules. You can add incident severity levels, but you must close the Rules editor for them to appear in the list of actions.
If, however, you already have severity levels and add another one, it will appear without you needing to close the Rules
editor.

This list links to tables that describe actions for the specic rule types:

• Actions for Answer Rules

• Actions for Contact Rules

• Actions for Incident Rules

• Actions for Chat Rules

• Actions for Opportunity Rules

• Actions for Organization Rules

• Action for Oer Advisor Rules

• Actions for Task Rules

Related Topics
• Business Rule Actions

Actions for Answer Rules  
These are the actions that you can choose for answer rules.

Action Description

Set Field Select this option, then select a eld to set or change.
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Action Description

Answer Access Sets the Access Level eld to the access level you select. To select multiple access levels, press Ctrl
while making each selection.

Assigned Sets the Assigned eld to the sta account you select.

Status Sets the Status eld to the status you select.

Banner Flag Sets the importance of the ag to the level you select from the drop-down menu and adds any text you
type in the Banner Note eld.

Set Custom Field Select an answer custom eld and set the value. You must add an answer custom eld to your site for it
to display.

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string.
The available actions depend on the variable’s data type. For variables to display, they must be added
to the Rules tree.
 

Email Select this action to send the following type of email notication.

Send Escalation Notication Sends an escalation notication to the sta member or group you select.
You can also select a check box to send the escalation notice to the sta person assigned to the
answer.
 
If multiple recipients are selected, press Ctrl and click a recipient to add it to (or clear it from) the list of
selected recipients.
 

Execute Object Event Handler Select this action to trigger an external event and then select the type of object event handler from the
drop-down menu.
For objects to display in the Execute Object Event Handler drop-down menu, they must be added on
the process designer and then the process model must be deployed.
 

Send Notication to Answer Sibling
Assignee(s)

Sends a notication to the owners of sibling answers.

Escalate Escalate the answer to the selected level and set other escalation seings.

Clear Escalation Clear the escalation level.

Related Topics
• Custom Field Types

• Variables in Business Rules

• Object Event Handlers

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks

Actions for Contact Rules  
These are the actions that you can choose for contact rules.

Action Description

Set Field Select this option, then select a eld to set.
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Action Description

At least one of a contact’s state elds must be set to Yes. If the contact has two of its three states
(Service, Opportunities, or Outreach) set to No and a rule action sets the third state to No, the action
will not be executed.
 

Service State Select Yes or No to set the Service state on the contact record.

Opportunities State Select Yes or No to set the Opportunity Tracking state on the contact record.

Outreach State Select Yes or No to set the Outreach state on the contact record.

Global Opt-in Select Yes or No to set the contact’s global opt-in choice.

Survey Opt-in Select Yes or No to set the contact’s survey opt-in choice.

Disabled Select Yes or No to disable the contact record.
You might want to use this action to disable any contact records that have been created through spam
email. To do this, create a rule with a condition for an email address containing the domain name and
an action to set the contact to disabled.
 

Contact Type Click this drop-down menu and select an option.

Banner Flag Sets the importance of the ag to the level you select from the drop-down menu and adds any text you
type in the Banner Note eld.

Set Date Acquired Click the drop-down menu on the left, select one of the following options, and then click the drop-
down menu on the right:

• Equals—With the current month calendar open, select the date acquired. Use the arrows to
change the month if necessary.

• Equal to the Value of—Select one of the following time options: now, the date the contact was
acquired, or the date the organization was acquired.

• Increment by—In the open window, select direction, oset, and units for incrementing the
acquired date.

• Decrement by—In the open window, select direction, oset, and units for decrementing the
acquired date.

Modify Service Level Agreements Select one of these options to create or terminate an SLA instance.

Create SLA Instance Lets you select an SLA from the drop-down menu and apply it to the contact.

Terminate Existing SLA Instance Terminates the contact’s SLA instance.
This action does not terminate an SLA instance that was created during the current editing session,
 only a previously existing one.
 

Set Custom Field Select a contact custom eld and set the value. You must add a contact custom eld to your site for it
to display.

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string.
The available actions depend on the variable data type. For variables to display, they must be added to
the Rules tree.
 

Email Select one of these options to send an email to the contact.
If you delete an email or transactional survey that is used in a rule, the rule base can still be activated,
 but the action will not be executed, and you will not be notied that the email was not sent.
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Action Description

Send Marketing Email Sends the mailing you select from the drop-down menu to the contact.
The default time for sending the mailing is 0 hours, but you can specify the number of minutes, hours,
 or days after rules processing ends that you want to send the mailing.
 

Send Transactional Survey Sends the survey you select from the drop-down menu to the contact.
The default time for sending the survey is 0 hours, but you can specify the number of minutes, hours,
or days after rules processing ends that you want to send the survey. The survey will only be sent to the
contact once per incident, regardless of how many times the rule is matched.
 
At least one transactional survey (set for rule visibility) must have been added for this option to appear.
 

Execute Object Event Handler Select this action to trigger an external event and then select the type of object event handler from the
drop-down menu.
For objects to display in the Execute Object Event Handler drop-down menu, they must be added on
the process designer and then the process model must be deployed.
 

Execute External Event This option was disabled in the February 2015 release.

Note:  External events have been deprecated and might be permanently removed in a future
release. Instead, use the Execute Object Event Handler action described in the previous row.

Related Topics
• Custom Field Types

• Variables in Business Rules

• Object Event Handlers

Actions for Incident Rules  
These are the actions that you can choose for incident rules.

Action Description

Set Field Select this option, then select a eld to set or change.
If customizable menu options have not been created, the Set Field action for that option (product,
 category, disposition, queue, or severity) does not appear on the menu.
 

Assigned Sets the Assigned eld to the sta account you select.

Status Sets the Status eld to the status you select.

Product Sets the Product eld to the product you select.

Category Sets the Category eld to the category you select.

Disposition Sets the Disposition eld to the disposition you select.

Interface Sets the Interface eld to the interface you select.

Queue ID Sets the Queue eld to the queue you select.
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Action Description

Mailbox Sets the Mailbox eld to the mailbox you select. Only those mailboxes enabled for outgoing mail are
options on this menu.

Severity Sets the Severity eld to the severity level you select.

Banner Flag Sets the importance of the ag to the level you select from the drop-down menu and adds any text you
type in the Banner Note eld.

Apply SLA Instance Credits the incident against the SLA for the contact or organization and lets you apply an SLA instance
if one does not exist.

Set Custom Field Select an incident custom eld and set the value. You must add an incident custom eld to your site in
order for it to display.

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string. The available actions depend on the variable data type. For variables to display, they
must be added to the Rules tree.

Append Thread Select this action to append any of these responses to the incident Note or Response elds. These
actions should appear in the order you want the response to be formaed.
For example, if you want standard text to appear before suggested answers in the response, add
the Append Response Template to Response Field action before adding the Append SmartAssistant
Response to the Response Field action. The Append Response Template to Notes Field action appears
only in the incident thread, not in the response.
 

Append Response Template to Notes Field Appends the standard text you select to the incident Note eld. This action is available only if you have
added standard text and selected the Rule Text check box on the Standard Text editor.

Append Response Template to Response
Field

Appends the standard text you select to the incident Response eld. This action is available only if you
have added standard text and selected the Rule Text check box on the Standard Text editor.

Append Existing Solution (by Answer ID) to
Response Field

Appends the solution for the Answer ID you enter to the incident Response eld.

Append SmartAssistant Response to
Response Field

Appends the SmartAssistant suggested answer links to the incident response.
If you restrict the SmartAssistant suggested answers by product or category, the product or category
value must appear in the subject or message text of the incident in order for matching answer links to
be generated.
 

Append Response to the Uncommied
Response Buer

Use this action in conjunction with any of the Append Thread actions except Append Response
Template to Notes Field.
This action appends the content you add to the incident response to the incident proposed response
eld rather than the incident thread. Content in the proposed response can be edited before it is saved
to the thread.
 

Email Select this action to send one of these email notications.
If you delete an email or transactional survey that is used in a rule, the rule base can still be activated,
 but the action will not be executed, and you will not be notied that the email was not sent.
 

Send Email Response to Sender Sends an email to the sender containing the incident subject and response.
To include the question and incident details in the email, select the appropriate check boxes. Do not
add this action unless you have selected one of the incident rule actions that append a thread to an
incident response. See actions available for Append Thread in this table.
 

Email Incident Information Sends a copy of the Question Receipt email message to the address you type in the eld or select from
a menu.
You can also send the information to the sta person assigned to the incident.
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Action Description

 
To include administration and customer elds, select the appropriate check boxes.
 

• Administration elds must be selected before you can select customer elds.

• Administration elds include the reference number, subject, date created, date last updated,
 status, assigned sta member, and the incident thread, including private notes.

• Customer elds include the contact’s email address, rst and last names, contact type, title, oce
phone number, organization, and any contact and organization custom eld data.

Send Escalation Notication Sends an escalation notication to the sta member or group you specify.
You can also select a check box to send the escalation notice to the sta person assigned to the
incident. If multiple recipients are selected, press Ctrl and click a recipient to add it to (or clear it from)
the list of selected recipients.
 

Send Marketing Email Sends the mailing you select from the drop-down menu to the contact for the incident.
The default time for sending the mailing is 0 hours, but you can specify the number of minutes, hours,
 or days after rules processing ends that you want to send the mailing. This option does not appear if
Outreach is not enabled and if no mailings have been created.
 

Send Transactional Survey Sends the survey you select from the drop-down menu to the contact for the incident.
The default time for sending the survey is 0 hours, but you can specify the number of minutes, hours,
or days after rules processing ends that you want to send the survey. The survey will only be sent to the
contact once per incident regardless of how many times the rule is matched.
 
At least one transactional survey (set for rule visibility) must have been added in order for this option to
appear.
 

Send Receipt Email Sends a receipt email to the contact associated with an incident that was created through channels
other than email or the Ask a Question page.
That is, if an incident is created by an agent on behalf of a customer, this action sends an email to the
contact.
 

Execute Object Event Handler Select this action to trigger an external event and then select the type of object event handler from the
drop-down menu.
For objects to display in the Execute Object Event Handler drop-down menu, they must be added on
the process designer and then the process model must be deployed.
 

Execute External Event This option was disabled in the February 2015 release.

Note:  External events have been deprecated and might be permanently removed in a future
release. Instead, use the Execute Object Event Handler action described in the previous row.

Do Not Create Incident Select this action to prevent an incident from being added. When an incident is being updated, this
action has no eect.

Do Not Send Email Receipt Message Select this action to prevent the normal transmission of the email receipt message to the sender. If the
incident meets the rule conditions, an automatic response is not sent to the customer.

Do Not Send Response Select this action to prevent an automatic response from being sent when an incident is updated.
For example, if your responses are delivered through a message system outside of Oracle Service
Cloud, you can use this rule to suppress an automatic response. To ensure all responses are
suppressed, this rule must be executed last.
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Action Description

Assign Incident to Sta Member
Assigned the Answer

Select this action to assign the incident to the same sta member who is assigned the answer.
This action has meaning only when the incident source is End-User Pages/Feedback on Answers. A
rule with this action res only when an incident is created, not when it is subsequently edited.
 

Escalate Select this action to escalate the incident to the level you select and set other escalation seings.

Clear Escalation Select this action to clear the escalation level.

Related Topics
• Custom Field Types

• Variables in Business Rules

• Overview of Answers

• Object Event Handlers

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks

Actions for Chat Rules  
These are the actions that you can choose for chat rules.

Note:  Actions that send or open a survey display only if surveys are enabled for use in chat rules.

Action Description

Chat Queue ID Select this action to assign the chat to the queue you select from the drop-down menu.

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string.
The available actions depend on the variable’s data type. For variables to display, they must be added
to the Rules tree.
 

Send Survey When Chat Completes Select this action to send a transactional survey when a chat session ends.
You can select the survey you want to send, and the period of time to wait before the survey is sent.
 

Pop-Up Survey when Chat Completes Select this action to open a website link survey in a new window when a chat session ends.
You can select the survey you want to display and the percentage of times you want to show the
survey.
 

Pop-Up Survey when Chat Request
Canceled

Select this action to open a weblink survey in a new window when a chat session is canceled.
You can select the survey you want to display and the percentage of times you want to show the
survey.
 

Terminate Chat Request Select this action to terminate the chat request.

ReQueue Chat Request in Select this action to requeue the chat request in the number of seconds you specify.

168



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Related Topics
• Variables in Business Rules

Actions for Opportunity Rules  
These are the actions that you can choose for opportunity rules.

Action Description

Set Field Select this option, then select a eld to set or change.

Assign Sets the Assigned eld to the sta account you select from the drop-down menu.

Status Sets the Status eld to the status you select from the drop-down menu.

Reject Lead Identies the reason the lead was rejected.
Select a status from the rst drop-down menu of available statuses with the Reject status type. Then
select a lead reject type from the second drop-down menu. Finally, enter a lead rejection description in
the text eld.
 

Interface Sets the Interface eld to the interface you select from the drop-down menu.

Banner Flag Sets the importance of the ag to the level you select from the drop-down menu and adds any text you
type in the Banner Note eld.

Set Strategy Hierarchy Sets the strategy hierarchy to the strategy you select from the drop-down menu.

Territory Sets the territory hierarchy to the territory you select from the drop-down menu.

Set Territory Hierarchy Based on Assigned Sets the territory hierarchy to the territory of the sta member to whom the opportunity is assigned.

Set Date Initial Contact

Set Lost Date

Set Recall Date

Date Closed

Sets specic opportunity dates.
For each of these date elds, click the drop-down menu on the left, select one of the following options,
and then click the drop-down menu on the right:
 

• Equals—With the current month calendar open, select the date. Use the arrows to change the
month if necessary.

• Equal to the Value of—Select one of the available options from the drop-down menu.

• Increment by—In the open window, select direction, oset, and units for incrementing the date.

• Decrement by—In the open window, select direction, oset, and units for decrementing the date.

Win/Loss Factor Identies the reason for winning or losing the opportunity.
Select a win/loss factor from the drop-down menu and enter a win/loss description in the text eld.
 

Set Custom Field Select an opportunity custom eld and set the value.
You must add an opportunity custom eld to your site for it to display.
 

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string.
The available actions depend on the variable data type. For variables to display, they must be added to
the Rules tree.
 

Email Select this action to send one of these email notications.
If you delete an email or transactional survey that is used in a rule, the rule base can still be activated,
 but the action will not be executed, and you will not be notied that the email was not sent.
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Action Description

 

Email Opportunity Information Sends the opportunity information to the email address you select from a menu of sta members,
 groups, and distribution lists. (Press Ctrl to make multiple selections.)
You can also select a check box to send the information to the sta person assigned to the opportunity.
To include administration elds and customer elds, select the appropriate check boxes.
 

Send Escalation Notication Sends an escalation notication to the sta member or group you specify. You can also select a check
box to send the escalation notice to the sta person assigned to the opportunity.

Send Marketing Email Sends the mailing you select from the drop-down menu to the contact for the opportunity.
The default time for sending the mailing is 0 hours, but you can specify the number of minutes, hours,
 or days after rules processing ends that you want to send the mailing.
 

Send Transactional Survey Sends the survey you select from the drop-down menu to the contact for the opportunity.
The default time for sending the survey is 0 hours, but you can specify the number of minutes, hours,
or days after rules processing ends that you want to send the survey. The survey will only be sent to the
contact once per incident, regardless of how many times the rule is matched.
 
At least one transactional survey (set for rule visibility) must have been added for this option to appear.
 

Execute Object Event Handler Select this action to trigger an external event and then select the type of object event handler from the
drop-down menu.
For objects to display in the Execute Object Event Handler drop-down menu, they must be added on
the process designer and then the process model must be deployed.
 

Execute External Event This option was disabled in the February 2015 release.

Note:  External events have been deprecated and might be permanently removed in a future
release. Instead, use the Execute Object Event Handler action described in the previous row.

Escalate Select this action to escalate the opportunity to the level you specify and set other escalation seings.

Clear Escalation Select this action to clear the escalation level.

Related Topics
• Custom Field Types

• Variables in Business Rules

• Object Event Handlers

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks

Actions for Organization Rules  
These are the actions that you can choose for organization rules.

Action Description

Set Field Select this option, then select a eld to set.
At least one of an organization state elds must be set to Yes. If the organization has two of its three
states (Service, Opportunities, or Outreach) set to No and a rule action sets the third state to No, the
action will not be executed.
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Action Description

 

Service State Select Yes or No to set the organization’s Service state.

Opportunities State Select Yes or No to set the organization Opportunity Tracking state.

Outreach State Select Yes or No to set the organization Outreach state.

Banner Flag Sets the importance of the ag to the level you select from the drop-down menu and adds any text you
type in the Banner Note eld.

Set Date Acquired Click the drop-down menu, then select one of these options:
• Equals—With the current month calendar open, select the date acquired. Use the arrows to

change the month if necessary.

• Equal to the Value of—Select one of the following time options: now, the date the contact was
acquired, or the date the organization was acquired.

• Increment by—In the open window, select direction, oset, and units for incrementing the
acquired date.

• Decrement by—In the open window, select direction, oset, and units for decrementing the
acquired date.

Modify Service Level Agreements Select one of these options to create or terminate an SLA instance.

Create SLA Instance Lets you select an SLA from the drop-down menu and assign it to the organization.

Terminate Existing SLA Instance Terminates the organization’s existing SLA instance. This action does not terminate an SLA instance
that was created during the current editing session, only a previously existing one.

Set Custom Field Select an organization custom eld and set the value. You must add an organization custom eld to
your site in order for it to display.

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string.
The available actions depend on the variable data type. For variables to display, they must be added to
the Rules tree.
 

Execute Object Event Handler Select this action to trigger an external event and then select the type of object event handler from the
drop-down menu.
For objects to display in the Execute Object Event Handler drop-down menu, they must be added in
the Process Designer, and then the process model must be deployed.
 

Execute External Event This option was disabled in the February 2015 release.

Note:  External events have been deprecated and might be permanently removed in a future
release. Instead, use the Execute Object Event Handler action described in the previous row.

Related Topics
• Custom Field Types

• Variables in Business Rules

• Object Event Handlers
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Action for Oer Advisor Rules  
Regardless of the conditions for Oer Advisor rules, the only action that occurs is predened: “Contact will match this
target.”

See Overview of Oer Advisor Administration.

Actions for Task Rules  
These are the actions that you can choose for task rules.

Task rules are executed rst when a task is updated at the same time as another object. Therefore, task actions based
on non-task conditions are executed using the current value for the object rather than the updated value.

For example, assume you have created a contact rule that sets a contact’s Opportunities state to Yes if the contact’s
global opt-in value is Yes. Also assume you have created a task rule that escalates a task if the contact’s Opportunities
state equals Yes. If a sta member updates the contact for a task by seing the global opt-in to Yes and then saves
the task, then the task will not be escalated. Because the task rule is executed before the contact rule, the contact’s
Opportunities state is not yet updated to Yes, so the task escalation does not happen.

Action Description

Set Field Select this option, then select a eld to set or change.

Assign Sets the Assigned eld to the sta account you select.

Status Sets the Status eld to the status you select.

Priority Sets the task priority to the priority you select.

Set Due Date To Sets the task due date to the date you select.

Set Planned Complete To Sets the task planned completion date to the date you select.

Task Start Date Sets the task start date to the date you select.

Task Complete Date Sets the task complete date to the date you select.

Set Custom Field Select a task custom eld and set the value.
You must add a task custom eld to your site for it to display.
 

Set Variable Set the variable to an absolute value, increment or decrement the variable, or append or prepend a
character string.
The available actions depend on the variable data type. For variables to display, they must be added to
the Rules tree.
 

Email Select this action to send one of these email notications.

Email Task Information Sends the task information to the email address you select from a menu of sta members, groups, and
distribution lists. Press Ctrl to make multiple selections.

Send Escalation Notication Sends an escalation notication to the sta member or group you specify. You can also select a check
box to send the escalation notice to the sta person assigned to the task.

Escalate Select this action to escalate the task to the level you specify and set other escalation seings.

Clear Escalation Select this action to clear the escalation level.
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Related Topics
• Custom Field Types

• Variables in Business Rules

• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks

Rules for Escalation of Answers, Incidents, Opportunities, and
Tasks  
The escalation function in business rules helps your organization track answers, incidents, opportunities, and tasks.

You can use rules for escalation to scan for problems, such as lack of follow-up by a sta member. Then the rule actions
occur, such as reminding the assigned sta member, notifying a manager, or sending an email to a customer. Every
escalation requires two rules. The rst one species the conditions that schedule an escalation and create an escalation
level. The second rule denes the actions that occur when the escalation level is reached.

To help you start thinking about escalation functions, these questions might remind you of situations you want to
automate.

• How are answers, incidents, opportunities, and tasks assigned to sta members?

• How soon should answers be reviewed after being proposed or created?

• What is an acceptable response time for incidents?

• What time frame is acceptable for sales representatives to contact new opportunities?

• What happens if a task is not completed by its scheduled completion date?

• Who should be notied if answers, incidents, opportunities, or tasks are not handled in a timely manner?

• What happens if the next level responder does not take action?

The scheduling of escalation involves these escalation options:

• Relative time—Calculates the number of minutes or hours from a specic day of the week or from an event,
such as time created or time updated. The relative time eld must have a value for this option to be meaningful.
For example, if you escalate an incident based on initial response and a response has not been sent yet,
escalation cannot be scheduled.

• Response interval—Uses the work hours dened in your default response requirements. When you select
this option, only working hours are used to determine relative time. If you clear this check box, incidents may
escalate during non-working hours. The Response interval escalation option is available only in incident rules.

• Revalidate—Veries that the object continues to match the rule conditions after being updated. If it no longer
matches, the object is removed from the scheduled escalation queue.

• Recalculate—Reschedules escalations that are based on events (such as time updated or time of last response)
when the object is updated and continues to meet the rule conditions. For example, if you schedule an
escalation four hours after an incident is updated, the original escalation schedule is recalculated if the incident
is updated before four hours elapse. The updated escalation is scheduled for four hours after the most recent
update.
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Note:  When the rules engine schedules an escalation but the Recalculate option is not selected,
updating the object does not update the scheduled escalation. The escalation remains scheduled
until it is executed or until revalidation removes it. For example, if you set an incident escalation action
+4 hours relative to “Now,” the rules engine schedules escalation when the rule rst executes. If the
incident is updated and the conditions still match, the escalation time continues to be based on the
original time, not the updated time.

• Clear Escalation action—Prevents escalation. For example, you might schedule escalation to ensure that a
response is sent within a certain time frame, but you should clear escalation after the response has been sent.
It is a good practice to select Revalidate to cancel the scheduled escalation when the Clear Escalation action is
executed.

Note:  Unlike incidents and tasks, answers and opportunities never reach a state where they cannot be
escalated, as incidents do when they are solved and tasks do when they are completed. To help you manage
these escalations, use the Clear Escalation action to prevent escalation and Revalidate to ensure that
scheduled escalations are removed.

Before you create escalation levels, you must understand the Dbstatus utility, which escalates objects and runs by
default four times an hour.

Related Topics
• How Escalation Rules Work

• How the Dbstatus Utility Updates the Escalation Level

• Process for Escalating Incidents

How Escalation Rules Work  
While escalation rules are most commonly applied to incidents, they can also be useful for managing answers,
opportunities, and tasks.

Escalation rules always come in pairs:

• The rst rule creates the escalation level for any incident, answer, opportunity or task that matches the rule
conditions. It tells the Dbstatus utility to set the escalation to the dened level when the time for escalation has
passed.

• The second rule species what you want to happen after the incident, answer, opportunity or task reaches this
escalation level.

For an example of escalation rules, see Escalate an Incident.

Tip:  We recommend creating a separate function where you can place escalation rules. See Add a Function.

Related Topics
• Rules for Escalation of Answers, Incidents, Opportunities, and Tasks

• Process for Escalating Incidents

• Create a Rule that Sets the Escalation Level

• Create a Rule that Triggers Actions on an Escalated Object
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Process for Escalating Incidents  
Here are the main steps necessary to create and implement rules that escalate incidents. The process is the same for
escalating answers, opportunities, and tasks.

1. Outline the chain of events for responding to an incident. For example, be sure you understand how much time
an agent has to respond to an incident before the agent’s supervisor should be notied. Continue this process
through all levels of escalation.

2. Add an escalation function to the incident rule base.
3. Add the rst rule to the escalation function.

This rule creates the escalation level and denes the conditions that cause the rules engine to set an escalation
level. For example, the condition might be a previous escalation level or an Unresolved incident status.

4. Add the second rule to the escalation function.
This rule species the action to take when the incident reaches the dened escalation level. For example, you
might add an action to notify a supervisor.

5. Repeat steps 3 and 4 for every escalation level.
6. Add a rule that calls the escalation function. Create a rule with no conditions and an action that calls the

escalation function you created in step 2, then add this rule to the initial state as the second-to-last rule.

Note:  Normally, you want the other rules in the state to be applied before escalation, and the last rule
in a state is usually an action to transition to the next state.

7. Repeat step 6 for every state in the incident rule base.

What happens now when an incident is added or updated?

• The rules engine applies all rules in the initial state to the incident, including the rule that calls the escalation
function. When it calls the escalation function, the rules engine begins processing the rules in the function,
comparing the incident to the conditions of each rule. If the incident matches the conditions of a rule, the rules
engine schedules the escalation and denes when it should escalate to the specied escalation level.

• Then, during a scheduled run, the Dbstatus utility compares the incident to the escalation schedule and, if the
time indicated in the escalation action has passed, it sets the incident escalation level to the one dened in the
rule.

• Because the incident has just been modied by having an escalation level set, the rules engine reprocesses the
incident. When it applies the rules in the escalation function to the updated incident, the escalation level now
matches the conditions of the second rule in the escalation function. Consequently, the escalation action (such
as notifying a supervisor) occurs. Rules can escalate an incident multiple times before it is solved.

How the Dbstatus Utility Updates the Escalation Level  
One function of the Dbstatus utility is updating the escalation level of answers, incidents, opportunities, and tasks.

Although the rules engine sets the escalation level for an object, Dbstatus updates the object. During one of
its scheduled runs, Dbstatus notes the time, then searches the knowledge base looking for answers, incidents,
opportunities, and tasks that have a scheduled escalation time less than the current time. It then updates those objects
with the dened escalation level.

After Dbstatus updates the object, the rules engine reprocesses the object to see if it now matches other rules in the
escalation function. This allows multiple steps of escalation based on the number of escalation levels you created.

Rules to escalate tasks, incidents, and opportunities use the conguration seings and message bases associated with
the interface of the object being escalated. Answer escalations use the conguration seings and message bases of the
interface from which Dbstatus runs.
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Create a Rule that Sets the Escalation Level  
This procedure shows you how to create a rule that sets an escalation level when the escalation level is applied to an
incident, but the procedure is the same when applied to answers, opportunities, and tasks.

Tip:  We recommend creating a separate function where you can place escalation rules. This procedure
assumes that the rules you create are placed in an escalation function.

Escalation rules always come in pairs. This procedure creates a rule that sets the escalation level for an incident that
matches the rule conditions. It tells the Dbstatus utility to set the escalation to the dened level when the time for
escalation has passed. The next rule must specify what you want to happen after the incident reaches this escalation
level.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click the buon for the rule type you want to create. The incident rule base is selected by default.
4. Click Edit.
5. Right-click the escalation function where you want to place the new rule and select New Rule.
6. Enter the rule name in the Rule Name eld.
7. Add the conditions that will trigger the escalation.

Tip:  When you create a rule to escalate an incident or other object that has not yet been escalated,
you can add a condition of Escalation Level equals Unspecified to ensure that you don’t escalate an
object that already has an escalation level previously set by another rule.

8. Click Add Action–Then and select Escalate.
9. Enter the values in the escalation action elds.

Field Description

Escalate to Level Enter a name for the escalation level you are creating in this eld.

Relative Select this check box to trigger escalation at a time relative to a day or event, which you
select from the drop-down menu to the right of the check box.
In the drop-down menu to the left of the check box, select a value to establish the time
relationship to the event. For example, you might select a relative time such as +4 hours
relative to Time Created.
 
Clear this check box to base escalation on absolute time.
 

This eld lets you schedule the escalation using absolute time. That is, you set the
specic time you want rather than scheduling escalation relative to another time.
Click the drop-down menu to open the current month calendar and select the escalation
date. To change the date or time, click the value you want to change, then enter a new
value.
 
Click anywhere in the date or time to set the exact date and time you want the answer,
 incident, opportunity, or task to escalate to this level.
 
This option appears only if the Relative check box is cleared.
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Field Description

Click the arrow to open a window for selecting the direction, oset, and units for the
relative time value. +1 Hours is the default. Enter the direction, oset, and unit for this
eld, then click Save.
This option appears only if the Relative check box is selected.
 

Direction Select + (future) or – (past) to indicate the direction of the oset for the escalation time
from the relative time you dene.
For example, you might want to escalate an incident 8 hours after (+8 Hours) the time of
the last response or an opportunity 4 hours before (– 4 Hours) the Forecast Close time.
 

Oset Select this eld and enter a new value to change the number of minutes or hours before
or after the relative time.

Unit Click the drop-down menu, then select minutes or hours.

Click the arrow to display the drop-down menu and select Now, Today, Tomorrow, any
day of the week, or any of the answer, incident, opportunity, or task options listed below.
This establishes the base time to which Dbstatus applies the relative escalation time.
You must select the Relative check box to display the menu.
 
If you select Today, Tomorrow, or any day of the week, the time associated with that date
eld is midnight. Therefore, if you create a rule to escalate an answer or an opportunity
+3 hours relative to Wednesday, then the escalation would be scheduled for the next
Wednesday at 3 A.M.
 
The same scenario holds true for incident escalation only if the Use Response Intervals
check box is cleared. If the Use Response Intervals check box is selected, the schedule
for escalation depends on the work hours that have been set since only work hours are
counted.
 
If, for example, work hours on Wednesdays begin at 6:00 A.M., then escalation for the
incident would be scheduled for Wednesday at 9:00 A.M.
 

Answers Select one of these escalation options based on the time the answer was added or
updated or is scheduled to be reviewed or published.

Answers.Created Select this option if you want the escalation time to be calculated from the time the
answer was added.

Answers.Updated Select this option if you want the escalation time to be calculated from the time the
answer was updated.

Answers.Review On Select this option if you want the escalation time to be calculated from the time the
answer is scheduled to be reviewed.

Answers.Publish On Select this option if you want the escalation time to be calculated from the time the
answer is scheduled to be published.
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Field Description

Incidents Select one of these escalation options based on the time the incident was added,
 updated, or responded to, or the time it is due.

Incident.Created Select this option if you want the escalation time to be calculated from the time the
incident was added.

Incident.Updated Select this option if you want the escalation time to be calculated from the time the
incident was updated.

Incident.Date Last Responded Select this option if you want the escalation time to be calculated from the time the
incident was last responded to. If the database contains no value for this eld (because
only the initial response has been recorded with no subsequent responses), the
escalation action will not occur.

Incident.Date Initial Solution
Response

Select this option if you want the escalation time to be calculated from the time of the
initial solution to the incident. If the value for this eld in the database is null (because
the incident has not been responded to yet), the escalation action will not occur.

Incident.Date Due Select this option if you want the escalation time to be calculated based on the relative
time due set in your default response requirements.

Opportunities Select one of these escalation options for opportunities.

Opportunity.Created Select this option if you want the escalation time to be calculated from the time the
opportunity was added.

Opportunity.Updated Select this option if you want the escalation time to be calculated from the time the
opportunity was updated.

Opportunity.Initial Contact Select this option if you want the escalation to be calculated from the date the customer
for the opportunity was initially contacted by a sales representative.
The time associated with this date eld is midnight. Therefore, if you create a rule to
escalate +3 days relative to Time Initial Contact and the initial contact occurred on
Monday morning, the escalation would be scheduled for midnight on Thursday.
 
If the value for this eld in the database is null (for example, if the customer for the
opportunity has not been contacted yet), the escalation action will not occur.
 

Opportunity.Forecast Close Select this option if you want the escalation to be calculated from the date the
opportunity is forecasted to close.
The time associated with this date eld is midnight. Therefore, if you create a rule to
escalate 12 hours before the forecasted close (that is, –12 hours relative to Time Close
Forecasted) and the opportunity was forecasted to close on Friday, the escalation would
be scheduled for Friday at noon.
 
If the value for this eld in the database is null (for example, the opportunity does not
have a forecasted close date yet), the escalation action will not occur.
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Field Description

Opportunity.Date Closed Select this option if you want the escalation to be calculated from the date the
opportunity closes.
The time associated with this date eld is midnight. Therefore, if you create a rule
to escalate 6 hours after the close date and the opportunity closed on Tuesday, the
escalation would be scheduled for 6:00 A.M. Wednesday.
 
If the value for this eld in the database is null (for example, the opportunity has not
closed yet), the escalation action will not occur.
 

Opportunity.Lost Date Select this option if you want the escalation to be calculated from the date the
opportunity was lost.

Opportunity.Recall Select this option if you want the escalation to be calculated from the date the customer
for the opportunity should be called again.

Tasks Select one of these escalation options for tasks.

Tasks.Completed Date Select this option if you want the escalation time to be calculated from the date the task
was completed.

Tasks.Created Select this option if you want the escalation time to be calculated from the date the task
was added.

Tasks.Due Date Select this option if you want the escalation time to be based on the task due date.

Tasks.Planned Completion Date Select this option if you want escalation to be based on the planned completion date of
the task.

Tasks.Start Date Select this option if you want escalation to be based on the task start date.

Tasks.Updated Select this option if you want escalation to be based on the date the task was updated.

Use Response Interval Select this check box to use the work hours dened in the default response
requirements set up for your organization.
If you clear this check box, incidents meeting the conditions might escalate during non-
working hours and holidays. This check box applies only to incident escalation and does
not appear with escalation actions for tasks, answers, and opportunities.
 

Revalidate Select this check box to revalidate the answer, incident, opportunity, or task, which
means that if it is edited and no longer matches the conditions of this rule, the
escalation action is removed from the scheduled escalations queue.
After an escalation that requires revalidation has been scheduled, the conditions of the
rule must continue to match when the object is updated. If they do not, the pending
escalation is canceled.
 

Recalculate Select this check to recalculate escalation time for the answer, incident, opportunity, or
task when it is updated.
The rules engine reschedules escalation based on the relative time value, such as four
hours after Time Updated. You must select a relative time value that is not static in order
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Field Description

for the Recalculate feature to be meaningful. If you select a static value, for example,
 Time Created, escalation is not rescheduled because Time Created remains static
even when the object is updated. If, however, you select Time Updated, escalation is
rescheduled because the Time Updated value changes when the object is updated.
 

This image shows a rule that sets an escalation level.

10. Click Save.

The next rule must specify what you want to happen after the incident reaches this escalation level. To do this, you
create another rule in the escalation function, as described in Create a Rule that Triggers Actions on an Escalated Object.

Related Topics
• Overview of Service Level Agreements

• Add a Function

Create a Rule that Triggers Actions on an Escalated Object  
This procedure shows you how to create a rule that performs an action when the escalation level is applied to an
incident, but the procedure is the same when applied to answers, opportunities, and tasks.

Tip:  We recommend creating a separate function where you can place escalation rules. This procedure
assumes that the rules you create are placed in an escalation function.

Escalation rules always come in pairs. This procedure follows the creation of a rule that sets the escalation level for an
incident that matches the rule conditions (see Create a Rule that Sets the Escalation Level). It tells the Dbstatus utility to
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set the escalation to the dened level when the time for escalation has passed. This procedure creates the next rule to
specify what you want to happen after the incident reaches this escalation level.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click the buon for the rule type you want to create. The incident rule base is selected by default.
4. Click Edit.
5. Right-click the escalation function where you want to place the new rule, then select New Rule.
6. Enter a name for the rule in the Rule Name eld.
7. Click Add IF Condition Based On and select Escalation Level equals <Escalation Level>.

This is the name of the escalation level created in the rule that sets the escalation level.
8. Click Add Action–Then to add the appropriate actions based on your business process.

For example, the rule action could be to send an escalation email to the assigned sta member of the incident.
9. Click Save.

You have now created a rule that sets the escalation level and a rule that species the actions to be taken when the
escalation level is detected during rules processing. As you create additional rules to set escalation levels and perform
actions, remember that only rules in the initial rule state initially process unless those rules transition to another state
or call a function. For the rules engine to process the rules in the function you place your escalation rules in, you must
have a rule that calls the escalation function.

To add more escalation levels and actions, repeat this process. After you have created your escalation rules, activate the
rule base. See Compilation and Activation of Rule Bases.

Related Topics
• Business Rule Actions

• Add a Function

Compilation and Activation of Rule Bases  
Whenever you make changes to a rule base, you must compile it to make sure that no errors exist. You must then
activate it so that the changes take eect.

Compiling lets you examine the state transitions and function calls to ensure that the rule base correctly reects your
intentions. You can compile the rule base as many times as necessary to ensure that it functions as planned.

You can activate the rule base when the compiling process convinces you that it functions the way you intend it to.
Activating the rule base archives the version of the rule base that existed before you began making changes and
incorporates the changes into the current rule base. Until you activate the rules you have been editing, they will not
process any records. To view the rules that are currently active, see How to View Rule Bases.

Note:  Whenever you make any changes to a rule base, you must activate the rule base for the changes to take
eect. However, activating the rule base does not automatically evaluate items in the knowledge base and
execute rules in the updated rule base.Assume, for example, that you have updated the incident rule base to
include a rule that applies an SLA instance to all incidents from a specic organization. Activating that rule
base does nothing to change existing incidents from that organization because the rules engine is invoked
only when incidents are added or updated, not when rule bases are activated.
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Compile a Rule Base  
This procedure uses contact rules as an example, but you can compile any type of rule using the same procedure.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click Contact, then click Edit to view the contact rules you will compile.
4. Click Compile.

A message asks you to conrm that you want to compile the rule base.
5. Click OK.

The compiler engine checks rules, states, and functions. If no errors occur, a message lets you know that the
rule base compiled correctly.

6. Click OK.
You can now continue editing the rule base.

Activate a Rule Base  
This procedure uses contact rules as an example, but you can activate any type of rule using the same procedure.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click Contact, then click Edit to view the contact rules you will activate.

Tip:  You can check whether changes to a rule base have been activated by comparing the Created and
Last Updated dates. If these dates and times are not the same, then changes have been made, but the
updated rule base has not been activated. In addition, the date in the Last Updated column will be red
to alert you that changes have not been activated.

4. Click Activate.
A message asks you to conrm that you want to activate the rule base.

5. Click OK.
The compiler engine checks rules, states, and functions. If no errors occur, a message lets you know the rule
base compiled correctly.

6. Click OK.
If objects are in the Null state or a state that has been removed, see Objects in the Null State. If no objects must
be reassigned to a dierent state, a message lets you know that the rule base has been activated.

7. Click OK to close the message and stop editing rules.

Abandon Changes to a Rule Base  
Abandon changes to a rule base to revert back to the last activated version.

CAUTION:  This action deletes all of the changes you have made to the rules, functions, states, and variables
in the current editing session.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and double-click Rules.
3. Click the buon for the rule base you want to abandon.

The incident rule base is selected by default.
4. Click Edit to view the rules currently in the edit state.
5. Click Abandon on the Rules editor.

A message asks you to conrm that you want to delete all of the changes made in this editing session.
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6. Click OK to delete the copy of the rule base you are editing, including all states, functions, rules, and variables.
All of the changes you have made are deleted, and the rule base reverts to the last activated version.

Objects in the Null State  
If the knowledge base contains records that were created before the rule base for that record type was activated, those
records are considered to be in a null state.

This means that the records will not be processed by the rule base when they are next edited, unless you move them
into an active state in the rule base. Records might also need to be reassigned to an active state if you delete the state
where they previously existed, so that the rule base will process them when they are updated.

If records associated with the rule base are in a null state when you activate the rule base, you will see a message similar
to:

Move the 114362 contacts in state with ID value of Null to ____

You can then click the drop-down menu to select the state where the records should be assigned.

The records you move to an active state are not processed by the rule base just because you move them to a new state.
However, they will be processed the next time they are edited, unless they remain in the Null state or a state that has
been deleted. In those cases, they will never be processed.

Note:  If you have deleted escalation levels when editing a rule base, you must also select new values for those
levels. If you select Null to replace the existing escalation level value, pending escalations are deleted and the
objects are not escalated. See Rules for Escalation of Answers, Incidents, Opportunities, and Tasks.

Change State Values When Activating a Rule Base  
Change the state value of records in a null state to an active state so they can be processed by a rule base.

1. When you see a message about moving records in a null state, click the drop-down menu and select the state
where you want to move the records.

2. Click Save.
A message lets you know that the rule base was activated.

3. Click OK to exit the rule base.

How to View Rule Bases  
When you view active rules, you see the rules, states, functions, and variables in the selected rule base that are currently
active that impact the incidents and other types of records on your site.

When you open the Rules editor, the View Active buon on the ribbon is selected. Unless you intend to make changes
to your rule base, it is a good idea to use the View Active option instead of Edit to prevent accidental modication of
the rule base and help you track changes to the rule base. When changes to the rule base are necessary, you can tell
if someone else has already begun making changes by looking at the Last Updated column on the Rules editor or the
Edited date when reviewing the active rule base.

In addition to viewing the rule base without editing it when you select View Active, you also have the option of restoring
the archived rule base. If, after viewing the rule base, you decide you want to revert to the previously archived version
of the rule base (that is, the last one that had been activated prior to the current version), you can restore the archived
version. After restoring the archived rule base, you must activate it for the restored version to become the new current
version.
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Note:  You can prevent sta members from editing rules by clearing the Rules Edit check box on the
Administration permissions tab of the Proles editor, but still let them view rules by selecting the Rules View
check box. See Administration Permissions.

Related Topics
• View a Rule Base

• Restore the Archived Version of the Rule Base

View a Rule Base  
Follow this procedure to view a rule base.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click the buon for the rule type you want to view.

Because View Active is selected by default, the rules displayed on the content pane are the active rules on your
site. The incident rule base is selected by default.
The content pane displays the dates the rule base was activated, edited, and archived and the sta member
who performed these actions. It also displays the transitions from one state to another and the states from
which functions are called.

An entry in the Edited column indicates that a copy of the active rule base has been created. A sta member
might have made changes or simply used the Edit option to open the rule base.

4. To view a state, right-click the state and select View State.
5. To view a function, right-click the function and select View Function.
6. To view a rule, right-click the rule and select View Rule.

Restore the Archived Version of the Rule Base  
Follow this procedure to restore the archived version of the rule base.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Select the rule type buon for the rule base you want to restore.

The incident rule base is selected by default.
4. Click Restore.

You are asked to conrm that you want to restore the archived rule base.
5. Click OK to conrm the restoration of the archived rule base.
6. Click Activate to activate the restored version of the rules base.

Note:  If you close this window without activating the rules base, the restored version is abandoned
and the current version of the rules base remains active.

Search a Rule Base  
You can search for names of states, functions, rules, and variables in rule bases, whether you are viewing active rules or
editing them. This lets you easily nd the items you need to view or edit, especially when working in a large rule base.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
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3. Click the buon for the rule base you want to view.
The incident rule base is selected by default.

4. Click Search located above the tree.
The Find window opens.

5. Enter the text you want to nd in the rule base tree in the Find What eld.
By default, the search is not case sensitive.

Tip:  Wildcards are automatically added to the beginning and end of the text that you enter. This lets
you search for items using text strings that are in the item names but that are not at the beginning or
end of the names. For example, entering b in the Find What eld returns all items containing the leer
“b.”

6. To make the search case sensitive, select the Match Case check box.
7. To locate items in the tree only if their names exactly match the search value you enter, select the Match Whole

Word check box.
8. To search for items starting at the boom of the tree and proceeding up, select Up. To start from the top of the

tree, select Down.
Down is the default.

9. Click Find Next to locate the rst state, function, rule, or variable in the rule base that matches the text you
entered.

10. Click Find Next again to locate subsequent items in the tree that match the text.
11. Click Close when you are nished with the search.

Modify a Rule Base  
You can modify a rule base, including all states, functions, and the rules contained in each.

Modifying a rule base lets you:

• Change the names of states, functions, and rules, and the conditions and actions in rules.

• Duplicate a rule to change its name, conditions, or actions. This option makes it easy to add a rule with similar
properties.

• Delete a rule.

• Temporarily disable a rule to prevent it from being considered when the system is processing workow.

• Move a rule to another state or function or change the order of a rule within a state or function by dragging and
dropping.

When you open a rule base and edit it, the system maintains the active rule base while you edit a copy in the Rules
editor. Your changes are not saved until you activate them. This prevents any disruption in rules processing during the
editing process, and ensures that you can revert to a functional rule base should you make any accidental changes while
editing.

CAUTION:  If you delete a state or function, you also delete all the rules within that state or function.

1. Right-click any rule in the rule base, then select one of the following options:

◦ Edit—Make the changes and save the rule. If the rule was not successfully updated, a message indicates
the value that is not valid.
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◦ Duplicate—Rename the rule, make the necessary changes, and save the new rule.

◦ Delete—A message asks you to conrm the deletion.

◦ Disable/Enable—The tree refreshes and a lock icon appears next to the rule to reect its disabled status.
The menu option changes to Enable when you right-click a disabled rule.

2. Make other changes to the rule base as necessary, such as reordering rules.

Because opening a rule base to make changes creates a copy of the active rule base, this action changes the Last
Updated column on the Rules editor (or the Edited date when you view active rules), regardless of whether you make
any changes.

Regardless of how you modify a rule base, you must activate it for the changes to take eect. See Compilation and
Activation of Rule Bases.

Verify a Rule Using the Rule Log  
You can use the rule log to view the list of rules that have red against a specic answer, contact, incident, opportunity,
organization, or task.

The rule log lets you verify that a rule base works as intended and that no unintended actions occur as a result. The rule
log also identies whether the Then or Else clause was used to process the rule.

Note:  When testing escalation, you might have to run the Dbstatus utility manually. However, keep in mind
that manually running Dbstatus to conrm an object’s escalation also escalates everything that has reached
the scheduled escalation time, not just the object you are testing.Be certain to congure email seings
before you construct rules to check inquiries and responses that were sent by email. See Overview of Email
Management for information about customizing email conguration seings.

1. Add and save a record, such as an incident, that matches the conditions of the rule.
2. Obtain the ID number of the object you want to view.

◦ Open the record on a workspace, click Info, note the ID number, and close the record.

◦ Open a report that includes the ID number of the record, such as the incident ID (incidents.incident_id)
eld. Note the ID number and close the report.

3. Click Conguration on the navigation pane.
4. Expand Site Conguration, then double-click Logs.
5. Click Rule Log.

The rule log opens on the content pane.
6. Click the Type drop-down menu, then select the type of record you want to view.
7. Enter the ID in the eld and click Search.

This image shows a rule log for an incident that triggered three rules.
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8. Check that the appropriate rules were applied to the record. If not, check the rules conditions and actions to see
why the record was processed in that way.

The rule log might contain more than one entry, depending on when it was last purged. The Agedatabase utility purges
the log after a congurable period of time (with a default of 30 days). The rule log might also indicate no matching rules.

Dependency Conicts  
If you aempt to delete an item (such as a rule variable, sta account, or queue) referenced in a rule, the system checks
to see if the item is related to business rules. If it is related, then a dependency conict might occur.

You will not receive a dependency conict warning if you delete a product, category, or disposition used in a rule.
However, if you try to delete a custom eld that is used in incident rules, you will see a Dependency Conict window
that describes the conicts.

Before you can delete the custom eld, you must resolve the dependency by editing or deleting the rule that causes the
dependency.

Note:  If you delete an email or survey that is used in a Send action in a contact, incident, or opportunity rule,
you can still activate the rule base but the rules engine will not process the action. No error will be logged to
indicate that the mailing or survey was not sent.

Business Rules Editor on the Agent Browser UI  
The business rules engine for the Agent Browser UI automates business processes for custom objects.

Some of the benets of the business rules engine for custom objects are:

• Makes creating business rules easier.

• Introduces searching for elds and values in rules.

• Gives access to related objects and aributes when dening rules.

• Runs reports on business rules.
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Note:  This business rules engine currently is only available in the Agent Browser UI and only works with
custom objects.

For more information, see Business Rules for Custom Objects.

Examples of Business Rules  
These examples can help you to understand business rules beer and create rule bases to streamline your
organization’s business practices.

• Rules for Routing Customer Support Questions

• Example of Automatically Sending Emails and Surveys

• Example of Seing Incident Status in Response to an Event or Action

• Example of Using SmartAssistant to Suggest Answers Before Questions are Submied

• Escalate an Incident

• Create a Variable to Measure Service Quality

• Examples of Applying Service Level Agreements (SLAs)

• Example of Using Relative Time Conditions

As there can be more than one way to accomplish the same objective using business rules, you might nd other
conditions and actions that let you achieve the same results as the sample rules described in this section. For complete
details about working with business rules, including an overview of rules as well as procedures for creating rule bases,
adding and editing rules, activating rule bases, and troubleshooting, see Overview of Business Rules.

Rules for Routing Customer Support Questions  
One of the more common uses of business rules is to route incidents to the most appropriate sta member, group, or
queue based on the criteria you dene.

These conditions can be related to the incident itself or to a eld in the contact or organization record associated with
the incident.

It might make sense to route certain types of incidents to a specic sta member. But the rules engine cannot
determine which sta members are logged in, so you risk having the incident assigned to a sta member who is not at
work when the incident is routed. To ensure a timely response for your customers, a beer practice is to assign incidents
to queues from which all logged-in agents can pull.

In the following examples, each rule has two actions: to route the incidents that match the criteria to the queue for Team
A, and then to move the incidents to a dierent state called “To be Processed.” (Best practice recommends you move
incidents out of the initial state after the rules engine has routed them so the rules engine does not continue to process
an incident using the rules of the initial state whenever it is updated.) In reality, you might have additional actions in any
given rule. For example, after assigning an incident to a queue, you might want to append SmartAssistant-suggested
answers to the incident before you transition it to a dierent rule state.

• Example of Routing Incidents by Source

• Example of Routing Incidents by Products or Categories

• Example of Routing Incidents by Time Created

• Other Incident Routing Conditions
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• Example of Building on Basic Incident Routing Rules

• How the Else Clause Can Simplify Business Rules

Example of Routing Incidents by Source  
You can use rules to route incidents to a specic queue or sta member.

You might have one queue dedicated to handling incidents that originate from the Ask a Question page on your
customer portal, another one for replying to email incidents, and another for chat requests. If this is how your support
team is organized, you will need a rule in the initial state for each type of incident source.

This image shows a rule that routes incidents to a specic queue.

Note:  It is also a good idea to add a nal rule to catch any incidents that enter your system through other
sources, so they can be assigned to a sta member instead of being overlooked.

Example of Routing Incidents by Products or Categories  
You can use rules to route incidents by their associated product.

Routing incidents by products or categories lets you direct them to the sta members who are experts in those areas.
This can be especially useful if members of your support team have highly specialized areas of knowledge. This image
shows a rule that routes incidents by their associated product.

Example of Routing Incidents by Time Created  
You can use rules to route incidents by the time created.

For example, if a customer submits a question before or after your support sta’s normal working hours, you might
want to route the incident to a backup sta member or queue who can respond to the customer. This image shows a
rule that routes an incident to a Tier 1 Queue when the incident is submied outside the normal working hours of 8:00
A.M. to 4:00 P.M.
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Note:  You can accomplish the same goal by using the operator In Response Interval. This operator is used
only with incident rules to indicate that the incident was added within normal working hours. “Normal
working hours” means either the response requirements of the SLA associated with the incident or the default
response requirements if no SLA is associated with the incident.

You might not want to route every incident created outside working hours to a backup queue. Instead, you might decide
to route only those that are added by certain customers. In that case, you can add another condition for the type of SLA
the customer has, or for the customer’s organization.

Note:  The default logical expression joins the conditions with AND (&), meaning that both conditions must be
met to trigger the action. If the logical expression used OR (|), the action would be triggered if either one of the
conditions was met.

Example of Building on Basic Incident Routing Rules  
Rules for routing incidents can be simple, but simple rules can serve as the building blocks for developing more complex
rules.

In this example, you add to the rule that routes incidents created outside working hours by customers from a particular
organization. (See Example of Routing Incidents by Time Created for the original rule.)

Assume that your organization wants to send a reply email to the customer who submits the incident. The reply should
include suggested SmartAssistant responses to the question and list normal working hours. Also assume that you want
to set the banner ag to high importance and send the incident to a customer support supervisor who can follow up if
necessary to ensure that the customer receives a reply.

The rule will resemble this image.
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Note:  In the revised rule, the Transition State action must be last for the other actions to be processed. After
you have added an action to stop processing rules or transition the state, the Add Action buon is no longer
available. As a result, you must rst delete the existing Transition State and Continue action from the original
rule, add the intermediate actions, and then add the Transition State and Continue action.

Other Incident Routing Conditions  
Besides source, products, categories, and time created, you can route incidents based on several other conditions.

This list describes some of the more common incident conditions. For a complete list, see Incident Conditions.

• Subject and threads—You might want to nd all incidents that contain a specic word or phrase or, conversely,
exclude those incidents from being impacted by rule actions. You can set conditions to search for text in the
incident subject as well as customer and sta threads.

Note:  When you create a rule comparing a string to the Incident Customer Thread, Incident Sta
Thread, Incident Proposed Response, or Incident Summary, you can use the Limit buer by option
that appears to specify the number of characters of the string the rule will search for in the most
recent entries, up to a maximum of 4000 characters. This can be helpful if you want to disregard initial
standard text. If no value is entered, the entire thread is compared.

• Status—Seing the incident status as a rule condition lets you nd and act on all incidents with the specied
status. For example, you might want to send a reminder email to all customers who have an incident with the
status Waiting.

• Previous elds—It might be useful to note when an incident status, assigned sta member or group, or
escalation level changes during rules processing. You can specify the previous value (that is, the value for the
eld stored in the database when the incident is added or updated or when rules processing begins) for these
elds as conditions for incident rules.

• Assigned sta member, group, or queue—If one of your sta members is out of the oce unexpectedly, you
might want to create a rule to reassign that person’s incidents. Similarly, one group or queue might have a
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heavier than normal volume of incidents and you might want to create a rule to direct some or all of those
incidents to a dierent group or queue.

• SmartSense ratings—You might want to email incidents that have strongly positive customer SmartSense
ratings to the sta member’s supervisor so that management can recognize agents who are serving customers
well. It might also be useful to let management know when a sta member’s SmartSense rating is negative so
corrective action can be taken if necessary. See SmartSense.

You can also route incidents based on rules you create using conditions for contacts and organizations. For example,
you might want to route incidents based on a customer’s geographic region, the date your organization acquired them
as a customer, or their industry.

How the Else Clause Can Simplify Business Rules  
You can probably use rules to accomplish everything you want without ever using the Else clause. But using the Else
clause can simplify your rules.

Rules are if-then statements: If this condition occurs, then take this action. Maybe you want incidents with a high
severity level to be routed to one queue, and those with any other severity level to be routed to a second queue.

Your rules could look like this:

• If Incident.Severity equals High, set queue ID to Queue 1.

• If Incident.Severity equals Average, set queue ID to Queue 2.

• If Incident.Severity equals Low, set queue ID to Queue 2.

• If Incident.Severity equals None, set queue ID to Queue 2.

Depending on the number of severity levels your organization uses, this could get unwieldy rather quickly. Instead, you
might create a dierent set of rules to accomplish the same thing:

• If Incident.Severity equals High, set queue ID to Queue 1.

• If Incident.Severity not equals High, set queue ID to Queue 2.

Even though the second rule set is more manageable than the rst, the Else clause oers you a single-rule solution.

Example of Automatically Sending Emails and Surveys  
Rules can automate some of your marketing eorts.

Assume, for example, that you want to send a message to all new customers in a specic geographic area to let them
know about a new store opening in their region. To accomplish this, your contact rule might look like this.

192



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Sending a survey is similar. The next image shows an incident rule that sends a customer support satisfaction survey
when an incident is solved.

Note:  The survey will only be sent to the contact once per incident, regardless of how many times the rule is
matched.

Tip:  We recommend seing the survey to send at least +1 minute after the incident is solved. Otherwise, if you
leave the seing to its default value of zero hours, the customer might receive the survey before they receive
the Incident Solved notication.

Example of Seing Incident Status in Response to an Event or Action  
You can set rules to change the status of an incident when an event occurs or an action is taken.

In this example, when an email is not delivered to the recipient and triggers an automated reply instead (that is, it
bounces), the incident status is set to Bounced. This alerts sta members that the email wasn’t received. They can then
resend the email or use an alternate contact method. This example uses the “Techmail–Incoming Auto-Reply Message”
source in the Transactions (transactions) table.
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Example of Using SmartAssistant to Suggest Answers Before Questions are
Submied  
This example is an action that oers suggested solutions to your customers when they submit incidents. These
suggestions might help them resolve their issues themselves, without requiring help from your support team.

The example rule described in  Example of Building on Basic Incident Routing Rules contained the action Append
SmartAssistant Response to Response Field.

SmartAssistant works by evaluating the text of the customer’s question and determining which answers in the
knowledge base best match the question. It then presents a list of these answers (to the maximum number specied in
SA_NL_MAX_SUGGESTIONS) to the customer in one or both of two ways:

• On the Ask a Question page of the customer portal before the customer completes submiing the question

• In the response thread of the incident that gets sent to the customer

To display the suggested solutions when the customer clicks the Continue buon on the Ask a Question page but not
append them to the incident response thread, the incident source condition must be equal to SmartAssistant on Ask a
Question.

To append the suggested solutions to the incident response thread but not display them when the customer submits a
question, the incident source must be equal to Ask a Question.

To oer the suggested solutions to the customer when they ask the question and in the incident response thread, the
condition for the incident source must have the check boxes for both SmartAssistant on Ask a Question and Ask a
Question selected.

Escalate an Incident  
Business rules let you escalate answers, incidents, opportunities, and tasks according to the conditions you dene. This
example shows how to create rules to escalate incidents.

Escalation lets you identify potential problems and take action before actual problems ensue. You might want to
escalate incidents that have not been resolved within your organization’s default response requirements. You can
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escalate answers that have been lingering in the review process and prevented from being published. Task escalation
lets you notify sta members when tasks are pending, and opportunity escalation prevents a potential sale from being
overlooked.

Each escalation action contains two rules:

• The rst rule species when to escalate the incident and creates an escalation level.

• The second rule species what happens when the escalation level dened in the rst rule is reached.

1. Create a function to contain the escalation rules, so that you can access the rules from any state in the incident
rule base.

2. Create the rst rule. This rule tells the Dbstatus utility to set an incident escalation level when the incident
matches the rule conditions.

a. Trigger the escalation if the incident status is unresolved, the incident has no current escalation level, and
no response has been sent to the customer.

b. In the action, create an escalation level called Tier 1 Escalation, which will be triggered 24 hours from the
time the incident was created.

c. Clear the Use Response Interval check box.
The 24 hours is calculated based on actual clock time. If the check box were selected, only your
organization’s normal working hours would be used to calculate the time.

d. Select the Revalidate check box.
Any updates to the incident will cause the rule conditions to be evaluated to see if they still match. For
example, if an agent responds to the customer, then you do not want the escalation to occur.

e. Clear the Recalculate check box.
The escalation time is relative to the time the incident was created, which is a static value that does not
change during rules processing

Your rst escalation rule should look like this.

3. Create a rule that says what happens when the incident reaches the Tier 1 Escalation level.
a. One of your conditions must be that the incident escalation level equals the level you created in the rst

rule.
b. Add other conditions as necessary.

195



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Your second escalation rule should look like this.

Now you have created a rule to set the escalation level for any incident that matches the conditions, and a rule to specify
what action should be taken when the escalation level is detected during rules processing.

Create a Variable to Measure Service Quality  
A variable is a temporary data item that is assigned a default value at the start of rules processing. You can dene rule
actions that update the variable during rules processing, and you can also dene conditions based on the value of the
variable.

A common example of a variable is a score that you set and modify according to the conditions you dene. Then you
can assign dierent actions based on the variable value.

In this example, let’s assume that you want to be sure your management team is aware of high-priority service issues.

• Your organization expects your agents to communicate positively with all customers.

• Because the XYZ Corporation constitutes a signicant part of your business, you want to be sure that contacts
from that company are satised with the service they receive from your organization.

• You want to be especially sure that managers from the XYZ Corporation are happy with your service.

Note:  A custom eld can also accomplish the same function as a variable. The dierence is that the value
of the custom eld is stored in the database at the end of rules processing. If its value changed during rules
processing as a result of actions applied to it, that value remains and is what the custom eld contains the
next time the object is processed by the rules engine. In contrast, the value of a variable is not stored in the
database, so its value is always 0 when rules processing begins the next time.

1. Create a variable called service_quality.
2. Create rules that set the value of the variable.

Because you want the variable to change based on dierent conditions, you will need multiple rules to
accomplish this. Rather than adding these rules to a state, create a function that scores the incident. Then you
can call the function from multiple states instead of having to add the set of rules to each state from which you
want to run them.

a. Create a function called Service Quality Scoring.
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b. Create rules within the Service Quality Scoring function that assign the appropriate weighting to the
various factors you want to track. You might choose to create a set of incident rules similar to these to
identify service issues:

- If the sta member’s SmartSense rating is Somewhat Angry, Angry, or Very Angry, then increment
the value of service_quality by +6.

- If the sta member’s SmartSense rating is Neutral, then increment the value by +1.
- If the organization is the XYZ Corporation, then increment the value by +2.
- If the customer SmartSense is Somewhat Angry, Angry, or Very Angry, then increment the value by

+6.
- If the contact type is Manager or Vice-President, then increment the value by +2.

3. Create rules that specify the actions for dierent values of the variable.

You might decide that high values of the service_quality variable warrant aention from a customer support
supervisor or manager. Your rules might look like these two gures:

◦ If service_quality is greater than 5 and less than or equal to 7, then email the incident information to the
customer support supervisor at your organization.

◦ If service_quality is greater than 7, then email the incident information to the manager of customer
support.
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Using these rules, you can see that:

• No email is triggered if a manager (+2) at XYZ (+2) is happy or neutral (no change because rule conditions are
not met), and if the agent SmartSense rating is neutral (+1). In this situation, the value is 5 (2+2+1).

• Any time a sta member’s SmartSense rating registers anywhere in the angry range, the customer support
supervisor is notied, because the value is at least 6.

• An angry customer will trigger a notication to the supervisor, because the value is also 6.

• An unhappy (+6) manager (+2) from XYZ (+2) results in a service_quality value of at least 10, and possibly more,
depending on the agent’s SmartSense rating. This situation triggers an email to the manager of your customer
support department.

Note:  Whenever the rules engine begins processing a new or updated incident, the value of the
service_quality variable is initialized to 0 again.

Examples of Applying Service Level Agreements (SLAs)  
Business rules let you apply SLAs (service level agreements) automatically to your customer records. You can apply
SLAs using contact, organization, or incident rules.

When you apply an SLA to a customer (either automatically through business rules or manually through the Service
Console), you dene a certain level of customer support to which the customer is entitled. Then, when the customer
submits an incident, the incident can be credited against the SLA, eectively reducing the number of remaining
incidents by one. In addition to using business rules to apply SLAs to the customer record, you can also use them to
credit an incident to an SLA.

SLAs can be applied only to contacts that are not associated with organizations. If a contact belongs to an organization,
then the SLA must be applied to the organization. Any incidents submied by contacts belonging to the organization
will be credited to the organization’s SLA.

Note:  Before you add rules to apply an SLA, you must Create an SLA.
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Related Topics
• Apply an SLA Using a Contact Rule

• Apply an SLA Using an Incident Rule

Apply an SLA Using a Contact Rule  
In this example, we apply a service level agreement (SLA) to all customers whose contact records are created during a
particular month.

You must already have SLAs to apply them. See Create an SLA.
1. Add a new contact rule.
2. Click  Add IF Condition Based On > Contact > Created .
3. Click  Select Operator > in range .
4. Use the calendar controls to set the date range.
5. Click  Add Action–Then > Modify Service Level Agreements > Create SLA Instance .
6. Select the SLA from the drop-down menu.
7. Add any other actions needed, such as state transitions, then click Save.

Your rule should resemble this image.

Related Topics
• Apply an SLA Using an Incident Rule

Apply an SLA Using an Incident Rule  
You can apply an SLA based on the conditions of an incident.

You must already have SLAs to apply them. See Create an SLA.

In this example, your organization has just released a new product that is causing customers some confusion. When
customers submit a question to your support team through the Ask a Question page regarding that product, you want
to automatically assign them an SLA that lets them submit a certain number of additional incidents regarding that
product for a specied time period.

Note:  Unlike contact and organization rules, incident rules do not have a Create SLA Instance action.

1. Add a new incident rule.
2. Click  Add IF Condition Based On > Incident > Product .
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3. Click  Select Operator > equals .
4. Select the product.
5. Click  Add Action–Then > Set Field > Apply SLA Instance .
6. Select the SLA from the drop-down menu.
7. Select the Create instance if one does not exist check box.

Note:  If the SLA has already been applied to the contact, it is not necessary to select the check box.

8. Select the Use the latest version of the SLA check box.
9. Add any other actions needed, such as state transitions, then click Save.

Your rule should resemble this image.

Related Topics
• Apply an SLA Using a Contact Rule

Example of Using Relative Time Conditions  
This is an example of selecting a relative time for a rule condition.

Several rule conditions let you select a date and time. For example, you might want to add a rule with the condition “If
the task due date is within the range from April 1 to April 8.” The following conditions allow date/time selection.

• Banner Updated for answers, contacts, incidents, opportunities, and organizations

• Acquired and Created for contact rules

• Created, Updated, Initial Contact, Forecast Close, Date Closed, Lost Date, and Recall for opportunity rules

• Acquired for organization rules

• Purchased Products Date Purchased for target rules

• Completed Date, Created, Updated, Due Date, Planned Completion Date, and Start Date for task rules

The ability to set a condition based on a specic date and time (whether that date/time value is before, after, equal
to, or within a range you specify) is a useful tool. However, there may be times when you want to set a relative date/
time value. For example, you might want a condition “If the task due date is less than 8 hours from now.” In that case,
you can select a relative time for the rule condition. Relative time calculates the number of minutes or hours from the
current time or from a specic event, such as time created or time updated.

This image shows a rule that can be used to notify a sta member who has been assigned a task that is due within the
next eight hours.
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Custom Fields  

Overview of Custom Fields  
When you rst implement Oracle Service Cloud, you might nd that additional elds are needed to collect the
information you require.

By adding custom elds to your knowledge base, you can be sure you are collecting the information required to best
meet your organization’s needs. For example, a company that sells shoes might need to store the customer’s shoe size.

After you’ve added custom elds, you can add them to workspaces and scripts, use them as search lters in reports,
and use them as audience lters in Oracle RightNow Outreach Cloud Service (Outreach) and Oracle RightNow Feedback
Cloud Service (Feedback).

Custom Field Types  
By adding custom elds to your knowledge base, you can be sure that you are collecting the information required to
best meet your organization’s needs.

Custom Field Type Description

Common You can add these types of Common custom elds: Sta Account, Contact, Organization, Sales
Products, and Task.

Sta Account Add this type of custom eld to store additional information about your sta members in their sta
account (for example, their hiring date). Sta account custom elds appear on the Custom Fields page
of the Sta Accounts editor.

201



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Custom Field Type Description

Contact Add this type of custom eld to gather additional information about your contacts (for example, their
age). Contact custom elds can be displayed when adding or editing a contact record, while engaged in
a chat session, and on the customer portal.

Organization Add this type of custom eld to gather additional information about your organizations (for example,
 the number of employees in the organization). Organization custom elds can be displayed when
adding or editing an organization.

Sales Products Add this type of custom eld to specify additional information about sales products in your product
catalog (for example, international product availability). Sales products custom elds appear on the
Custom Fields page of the Product Custom Fields editor.

Task Add this type of custom eld to store additional information about tasks for your sta members when
adding or completing a task.

Service You can add these types of Service custom elds: Incident and Answer.

Incident Add this type of custom eld to gather additional information about customers’ questions (for
example, model and serial numbers). Incident custom elds can be displayed when adding or editing
an incident and on the Ask a Question and Support History pages.

Answer Add this type of custom eld to store and provide additional information about answers in your
knowledge base (for example, version numbers the answer applies to). Answer custom elds can be
displayed when adding or editing an answer and on the Answers and answer detail pages.

Opportunity Tracking You can add these types of Opportunity Tracking custom elds: Opportunity and Quote.

Opportunity Add this type of custom eld to gather additional information about opportunities (for example, the
contact’s previous service or product). Opportunity custom elds can be displayed when adding or
editing an opportunity.

Quote Add this type of custom eld to store additional information about the sales quotes sent to customers
(for example, the date the quote was requested). Quote custom elds can be displayed when adding or
editing an opportunity.

You can create folders to group and organize your custom elds in the Custom Fields tree. By dragging and dropping
custom elds in the tree, you can reorder them or move them into folders.

When you add or edit custom elds, those modications can be completed in real time or scheduled and performed
in the background. Sta members and customers can continue to use your site while the background operation is in
progress. After a custom eld operation is scheduled, it cannot be modied or aborted.

Add or Edit a Custom Field  
Adding custom elds is similar for each of the custom eld types. Although this procedure is for adding a contact
custom eld, use the same procedure to add all other types of custom elds.

When adding a custom eld, you can specify whether it is visible and editable on the Service Console and, for some
custom elds, visible and available to gather details on the customer portal. You can also specify a data type for the eld,
choose whether the eld is required or not, and set a default value. Text eld data types let you create an input mask to
require that information entered in the eld matches a dened format.
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Note:  A combined maximum of 500 custom elds and system aributes can be created for each standard
object. That is, if you have 100 incident custom elds, you could create 400 system aributes for the incident
object. In addition, a combined maximum of 9 custom elds and system aributes can be indexed for each
standard object.

1. Double-click Custom Fields in  Conguration > Database .
2. Do one of these:

◦ To add a contact custom eld, in Custom Fields click Contact, then click New.

◦ To edit a contact custom eld, click it in the tree.

3. Enter the name of the custom eld in Name.

Tip:  You can assign a shortcut key to the custom eld after you have added it on the workspace
designer.

4. Click Data Type and select the data type for this eld.

Note:  You cannot change the data type when editing an existing custom eld.

Data Type Description

Date Field Select this option to add a custom eld for entering a date. For sta members, the date
is entered using a calendar. For customers on the customer portal, the date is entered
using separate drop-down menus for month, day, and year.

Date/Time Select this option to add a custom eld for entering a date and time. For sta members,
the date is entered using a calendar and the time is entered through a separate eld. For
customers on the customer portal, the date is entered using separate drop-down menus
for month, day, year, hour, and minute.

Integer Select this option to add a custom eld for entering numeric values (for example,
 product or registration numbers). Integer elds can contain up to 10 digits.

Menu Select this option to add a eld with a drop-down menu from which customers and sta
members can select an item.
Menu type custom elds are the only custom elds that display in answer reports
through Oracle RightNow Wireless.
 

Text Area Select this option to add a text box (1-4000 characters).

Text Field Select this option to add a text eld (1-255 characters).
Masks can be used only with Text Field data types.
 

Yes/No Select this option to add a eld with a Yes and No option.

Opt-in Select this option to add a custom eld that lets customers opt in or out of Outreach
mailings and Feedback surveys.
This option is available only when adding a contact custom eld.
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5. Enter eld information. The available elds vary depending on the selected data type.

Field Descriptions

Field Aributes Select from these eld aributes. The data type you selected determines which eld
aributes are available.

*Column Name Enter the name of the eld as you want it to appear in the database. You cannot use
spaces or punctuation, and the value cannot start with a number. The column name in
the database will be appended with the prex c$. For example, if you add a custom eld
with the column name calling_plan, it will appear in the database as c$calling_plan.

Indexed Select this check box to add a database index. This is useful if you want to use this
eld as a xed or runtime lter in reports. Indexing, although not necessary, can make
searching more ecient when the eld is frequently searched on.
Indexing is not available for the text area and Yes/No data types. Also, only nine custom
elds can be indexed per database table.
 

Required Select this check box to make the custom eld required when you initially add the eld
to a workspace. This seing can be overridden by the eld’s behavior properties in the
workspace.
This option is available only for sta account and sales product custom elds.
 

Required for Customer Portal Select this check box to make the custom eld required on the customer portal.
This option is available only for contact and incident custom elds.
 

Hint Enter additional prompt information to display on the administration interface and the
customer portal. The hint appears to customers to the right of the custom eld in a
smaller font than the name. It appears to sta members when they hover over the eld
on the administration interface. The hint eld can contain up to 4000 characters.

Notes Enter any notes about the custom eld in this text box.

Data Details Select from these data details. The data type you selected determines which elds are
displayed in this section.

Mask Enter an input mask to restrict what can be typed in the eld when you select Text Field
as the data type and the Plain Text or Phone as the usage.
This option is available only with text eld data types.
 

Default Value Select or enter a default value for this eld. Default options depend on the type of eld.
For example, a Yes/No eld has three options from which you can choose a default (Yes,
 No, None). Other eld types require you to enter a value.

Menu Items To add a menu item, click Add at the top of the Data Details section. The added items
appear at the boom of the list.
To delete a menu item, select the row containing the item and click Delete at the top
of the Data Details section. Use the up and down arrows to change the order of menu
items.
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Field Descriptions

 
This option is available only with menu data types. If you have selected this data type,
 you must enter at least one menu item.
 

Sort by Sequence in Reports by
Default

Select this check box to make the custom eld order the default sorting option for menu
custom elds in reports. If you do not select this check box, the default option will be
alphanumeric sorting.

Name Enter the name of the item in the Name column of the menu items grid.

Default Select the Default check box to make a menu item the default selection in the drop-
down menu.

Label Enter the label of the menu item for each interface.
Each language can have a dierent label. In interfaces that have the same language as
the primary interface, the Label eld will always match the menu item Name eld.
 

Size of eld Enter the maximum number of characters for this eld. This option is available for text
elds. Text elds can contain up to 255 characters.
This eld is required if you have selected the text eld data type. This eld will be
automatically completed if the eld has a mask.
 

Minimum Enter the minimum value for this eld. This option is available for integers. Integers can
contain up to 10 characters.
This eld is required if you have selected the integer data type. The smallest value
allowed for this eld is -2147483645.
 

Maximum Enter the maximum value for this eld. This option is available for integers. Integers can
contain up to 10 characters.
This eld is required if you have selected the integer data type. The largest value
allowed for this eld is 2147483647.
 

Usage Click this drop-down menu to select how the custom eld is displayed when editing a
record containing the custom eld:

◦ Plain Text—The value of the custom eld is displayed as a plain text eld.

◦ URL—The value of the custom eld is a URL and sta members can click a buon
to open the URL in a web browser.

◦ Email Address—The value of the custom eld is an email address and sta
members can click a buon to send an email.

◦ Phone Number—The value of the custom eld is displayed as a phone number.

This option is available only with the text eld data type.
 

Interface Visibility Select the interface visibility options and create labels and hints for this eld on each
interface.
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Label Enter the text prompt for the custom eld. This is the prompt that sta and customers
will see on the interface.
Each language can have a dierent label. In interfaces that have the same language as
the primary interface, the Label eld will always match the Name eld.
 

Hint Enter the hint that will appear when sta and customers hover over the eld label.
Each language can have a dierent hint. In interfaces that have the same language as
the primary interface, the Hint eld in the Interface Visibility grid will always match the
primary Hint eld.
 

6. Click Save.
7. Click Yes.

Note:  If your site has 100,000 or more rows in its database table, a ag appears next to the custom
eld in the Custom Fields tree along with the label “Scheduled” or “In Progress.” After the operation is
complete, the Custom Fields tree is refreshed and the ag and label no longer appear.

Related Topics
• Input Masks

• How You Set Hidden, Required, and Read-Only Properties

• Custom Field Visibility Seings

Custom Field Visibility Seings  
When adding custom elds, you have several visibility options. The visibility options dene where and how custom
elds are presented on the administration interface and the customer portal.

Custom elds with end-user visibility are displayed on the customer portal. If you display a custom eld that is not
editable by customers, it does not appear on the Ask a Question page. There are other ways to determine visibility on
the customer portal, such as widgets and page code.

Note:  Answer, incident, contact, opportunity, organization, quotes, and tasks custom elds must also be
added to the appropriate record’s workspace. The Admin Edit visibility seing must be selected for a custom
eld to be available to add to workspaces and scripts. After a custom eld is added to a workspace or script, its
visibility, read-only, and required aributes are determined by the properties set in the workspace or script.

Field Description

Sta Account These visibility options are available for sta account custom elds.

Admin Edit Select this check box to allow sta members to set the value of this eld when adding or editing a sta
account. If cleared, the eld will not be visible on the Custom Fields page of the Sta Accounts editor.
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Field Description

Analytics/Segments Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports. Selecting this check box also allows the use of this eld for ltering and grouping in segments.

Contact These visibility options are available for contact custom elds.

Admin Display Select this check box to allow the custom eld to be added to contact workspaces and to display the
custom eld when adding and editing contact records.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing a contact record.
You cannot select this check box if the Admin Display check box is cleared.
 

End-User Read Select this option to allow customers to view this custom eld when updating their prole through the
Your Account page. The custom eld appears to the customer, but cannot be edited.
You cannot select this option if the End-User Edit check box is cleared.
 

End-User Read/Write Select this option to allow customers to set the value of the custom eld when updating their prole
through the Your Account page.
You cannot select this option if the End-User Edit check box is cleared.
 

Outreach and Feedback Merge Select this check box to allow the custom eld to appear when adding a merge eld in Outreach or
Feedback. If cleared, the custom eld will not be available in the menu of elds on the Merge Field
window.

Outreach and Feedback Web Form Select this check box to allow the custom eld to appear on the Web Form Field window when adding
or editing a document or survey with a web form. If cleared, the custom eld will not be available in the
menu of elds on the Web Form Field window.

Outreach and Feedback Edit Select this check box to allow the custom eld to appear when seing a eld through a campaign
or survey ow. If cleared, the custom eld will not be available in the menu of elds on the Set Field
window.

Analytics/Segments Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports. Selecting this check box also allows the use of this eld for ltering and grouping in segments.

Incident These visibility options are available for incident custom elds.

Admin Display Select this check box to allow the custom eld to be added to incident workspaces and to display the
custom eld when adding and editing an incident.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing an incident.
You cannot select this check box if the Admin Display check box is cleared.
 

End-user Display Select this check box to display the custom eld on the Support History page when customers view a
previously submied incident.

End-user Edit Select this check box to allow customers to set the value of this eld when submiing an incident
through the Ask a Question page.

Chat Display Select this check box to allow this eld to be added to chat workspaces and to allow customers to set
the value of this eld when requesting a chat session from the Live Help page.
To be able to add an incident custom eld to a chat workspace, you must also select the Admin Display
check box.
 

Answers Migrate on Propose Select this check box to migrate the value of the custom eld when an incident becomes an answer.
The value of the custom eld is placed in the Notes eld of the proposed answer.
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Field Description

Outreach and Feedback Merge Select this check box to make the custom eld available when adding a merge eld in Outreach or
Feedback. If cleared, the custom eld will not be available in the menu of elds on the Merge Field
window.

Analytics/Segments Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports. Selecting this check box also allows the use of this eld for ltering and grouping in segments.

Organization These visibility options are available for organization custom elds.

Admin Display Select this check box to allow the custom eld to be added to organization workspaces and to display
the custom eld when adding and editing organization records.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing an organization record.
You cannot select this check box if the Admin Display check box is cleared.
 

Analytics/Segments Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports. Selecting this check box also allows the use of this eld for ltering and grouping in segments.

Answer These visibility options are available for answer custom elds.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding and editing answers.

End-user Display Select this check box to display the custom eld to customers on the Answer Details page.

Analytics Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports.

Opportunity These visibility options are available for opportunity custom elds.

Admin Display Select this check box to allow the custom eld to be added to opportunity workspaces and to display
the custom eld when adding and editing opportunities.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing an opportunity.
You cannot select this check box if the Admin Display check box is cleared.
 

Outreach and Feedback Merge Select this check box to make the custom eld available when adding a merge eld in Outreach or
Feedback. If cleared, the custom eld will not be available in the menu of elds on the Merge Field
window.

Analytics/Segments Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports. Selecting this check box also allows the use of this eld for ltering and grouping in segments.

Quotes These visibility options are available for sales quotes custom elds.

Admin Display Select this check box to allow the custom eld to be added to quote workspaces and to display the
custom eld when adding and editing quotes.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing a quote through an opportunity.
You cannot select this check box if the Admin Display check box is cleared.
 

Analytics Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports.

Sales Products These visibility options are available for sales products custom elds.
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Admin Edit Select this check box to allow sta members to set the value of this eld when adding or editing a sales
product. If cleared, the eld will not be visible on the Custom Fields page of the Product Custom Fields
editor.

Quotes Display Select this check box to display the custom eld when adding or editing a product in an opportunity’s
quote. The custom eld appears on the Quote Product Edit window.
You cannot select this check box if the Admin Edit check box is cleared.
 

Quotes Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing a product in an opportunity’s quote. The custom eld appears on the Quote Product
Edit window.
You cannot select this check box if the Admin Edit check box is cleared.
 

Purchased Products Display Select this check box to add the custom eld to the purchased_products database table. The eld is not
visible to sta members or customers.
You cannot select this check box if the Admin Edit check box is cleared.
 

Purchased Products Edit Select this check box to add the custom eld to the purchased_products database table. The eld is not
visible to sta members or customers.
You cannot select this check box if the Admin Edit or Purchased Products Display check box is cleared.
 

Analytics/Segments Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports. Selecting this check box also allows the use of this eld for ltering and grouping in segments.

Task These visibility options are available for task custom elds.

Admin Display Select this check box to allow the custom eld to be added to task workspaces and to display the
custom eld when adding and editing tasks.

Admin Edit Select this check box to allow sta members to enter or change the value of the custom eld when
adding or editing a task.
You cannot select this check box if the Admin Display check box is cleared.
 

Analytics Display Select this check box to allow the custom eld to be used as a lter or output column in custom
reports.

Related Topics
• Custom Field Types

Input Masks  
Input masks are dened paerns that determine the format of information that can be typed in a text eld.

Input masks are useful for preventing data entry errors when a text eld has a specic input format that must be
followed.

To dene a mask paern, two characters are required to represent one character or digit in a masked text eld. The rst
character does not display in the masked text eld, but acts as a rule to dene the acceptable input format. The second
character displays in the masked text eld and acts as an input hint for sta members and customers.
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This table describes the rst and second characters that dene mask paerns.

Mask character Description

First character

F Formaing character (space, hyphen, parentheses)

U Uppercase leer

L Lowercase leer

M Ignore case (lowercase, uppercase, and numbers are acceptable)

Second character

# Numeric (number only)

A Alphanumeric (either leer or number)

L Alpha (leer only)

C Alphanumeric or formaing character

Input mask examples
This table describes input mask types, their associated paerns, and how they display to sta members and customers
in text elds.

Note:  In a masked text eld, the # symbol signies a numeric character and the @ symbol signies an
alphabetic or non-numeric character. Formaing characters, such as spaces, hyphens, and parentheses, are
static so sta members and customers cannot replace them with other characters.

Mask Type Mask Paern Masked Text Field

Social Security Number
123-45-6789
 

M#M#M#F-M#M#F-M#M#M#M# ###-##-####

Phone number
(123) 456-7890
 

F(M#M#M#F)F M#M#M#F-M#M#M#M# (###) ###-####

U.S. zip code
12345-6789
 

M#M#M#M#M#F-M#M#M#M# #####-####

Canada postal code
A1B 2C3
 

ULM#ULF M#ULM# @#@ #@#
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Custom Objects  

Overview of Custom Objects  
Custom objects allows administrators and developers to rapidly build and extend applications that support unique
business processes.

By creating custom objects, you can seamlessly integrate organization-specic data with Oracle Service Cloud, leing
you manage and report on the data in the same way you manage and report on incidents, contacts, and other standard
objects. Because custom object data is stored in the database, you can add custom objects to workspaces, workows,
custom reports, and navigation sets.

Note:  Building a complete custom object solution often requires creating dierent types of custom objects,
including packages, objects, menu-only objects, and system aributes. For the sake of simplied discussion,
these items are all referred to as custom objects in this documentation unless stated otherwise.

You can take your time when initially creating custom objects to ensure they are correct since they are not wrien to the
database until you deploy them. In addition, since you can export custom objects and import them into other Oracle
Service Cloud sites, you can create, deploy, and test custom objects on a non-production site, export them, and then
import them into your production site. See Deploy Custom Objects.

After deploying objects that have the appropriate option selected, workow and workspace types are automatically
created for them and additional prole permissions are made available. This lets your sta members work with
custom objects exactly as they work with standard objects. For example, if you create and deploy an object to store
product registration information, a new workspace type will be created that you can use to create new product
registration workspaces. You can then add the workspace to your navigation set and edit your prole to grant
permissions to manage product registration information. Standard reports are also automatically created for objects
that have associated workows and workspaces so you can quickly locate specic custom object records and view the
relationships between objects. See What to Do with Custom Objects After Deployment.

Object Designer  
You use the object designer to create custom objects, import objects that were created on other sites, and deploy
custom objects to your database.

To access the object designer, the Object Designer permission must be assigned to your prole on the Administration
tab of the Prole Permissions editor. See Administration Permissions. You might also need to add the Object Designer
component to your navigation set. See Create a Navigation Set for the Administrator.

CAUTION:  Due to the high degree of change that can be made to your application and database using
custom objects, we recommend that few sta members be granted permission to use the object designer.
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Related Topics
• Custom Object Types

• Export and Import of Custom Objects

• What to Do with Custom Objects After Deployment

• Deploy Custom Objects

Custom Object Types  
Several types of items are available to use in your custom objects solutions, and all are created using the Objects
Designer. While some solutions will require one or two of these items, other, more complex, solutions might require all
of these items.

• Package—Packages are containers that store objects, menu-only objects, and system aributes.

• Object—Objects contain elds, indices, and relationships that you dene. You can create elds with dierent
data types and other options, and some predened elds are available for notes, transactions, and other items.
When you create and deploy an object, a new table containing the elds you specify is added to the database.

• Menu-Only Object—Menu-only objects contain only menu options that you dene. These are created to
populate options in menu elds you want to add to multiple objects. Unlike objects, menu-only objects do not
have options for elds, indices, and relationships (relationships to menu-only objects are created automatically
when you use menu-only objects in an object). When you create and deploy a menu-only object, a new table
containing the menu options is added to the database.

• System Aribute—System aributes are elds that can be added to standard objects, such as incidents and
contacts. You can select data types, indices, and dene relationships for these elds. System aributes can be
used in workspaces and reports, just like custom elds can. When you create and deploy a system aribute, a
new eld is added to the table for the appropriate standard object (such as the incidents table).

Note:  You can add a maximum of 200 objects, and each package can contain up to 23 objects. Menu-only
objects do not count toward these limits.

The relationships you dene between objects and system aributes help dene what you can do with your custom
object solution. For items to interact with one another, relationships must be created between them. You can dene
relationships between objects, system aributes, and standard objects. For example, if you created a product
registration custom object, you could create a relationship between it and the contacts table. You could also create
an object to store information about locations where the product could be purchased, and then create a relationship
between the objects. Using this scenario, you could track who registered the product and where they purchased it,
managing information in a single workspace and displaying it in custom reports.

Before you create any custom objects on your production site, we recommend that you create and deploy them on a
test site to ensure they function as expected. However, you can edit or delete custom objects if necessary, whether they
have been deployed or not.

Note:  Only one sta member can edit or create objects in the object designer at a time. An option to override
the lock on the object designer is displayed if you aempt to edit or create an object when another sta
member is already doing so.

Custom Object Packages  
Objects, menu-only objects, and system aributes are all stored in packages that you create. You can place objects in
any package you want, but storing related objects in the same package helps you manage them.

212



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

The object designer includes one default package, named CO, to give you a head start when creating custom objects.
You can add objects, menu-only objects, and system aributes to this package, just like you can with any of the
packages you create.

The object designer’s tree also includes a list of standard objects under the OracleServiceCloud entry to help you
manage system aributes. System aributes are stored in packages just like objects are, but it can be challenging to
manage numerous system aributes that are stored in several packages. The entries in the OracleServiceCloud list
display all the system aributes created for dierent standard objects. For example, if you click the Contact entry in the
OracleServiceCloud list, you will see all the system aributes that have been created for the contacts standard object,
grouped by the package they are in.

Create a Custom Object  
When you create an object, you are creating a new table in the database. You can specify elds, indices, and database
relationships for each object you create.

1. Double-click Object Designer in  Conguration > Database .
2. Choose one of these options:

◦ Select a package to which you want to add the custom object.

◦ To create a new package for the object, click  New > Package .

When naming new packages, names must be between two and eleven characters in length. Package names are
used in the names of tables created in the database for custom objects. For example, if you create a Warranty
object in the default CO package, the resulting table name will be CO$Warranty.

3. Click  New > Object .
4. Enter a name for the object.

The name you dene identies the object in the database. Sta members generally see the custom object’s
label, dened later in this procedure, when working with the object. Object names must start with a leer,
cannot contain special characters other than the underscore character (only single underscores are allowed),
and cannot contain more than twenty characters. In addition, certain words cannot be used as object or eld
names since they are reserved for use by other processes. If you aempt to save an object that uses a reserved
word, a validation message informs you that the name must be changed.

5. Enter eld information.

Field Description

Object Options Select options in this section to specify where the object is available and other options.

Object is Available in Workspaces,
 Scripting, and Workow

Select this check box to make the elds available for use in scripts, workspaces, and
workows. Standard reports and workow types are created automatically for objects
that have this option enabled. Objects do not require this option to be used in custom
reports. See Custom Objects on the Service Console.
This option is enabled by default.
 

Object is Enabled for Transactions Select this check box to enable tracking of all create and update actions taken on
the object’s unique records. The transaction data is stored in the Custom Object
Transactions (co_trans) table and can be viewed using the Audit Log workspace
relationship item.
This option is enabled by default.
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Field Description

 

Object Generates User Transactions Select this check box to enable tracking of create, update, and cancel actions taken
on the object’s unique records by sta members. The transaction data is stored in the
Custom Object Transactions (co_trans) table and can be viewed using custom reports.

Object Generates Menu Select this check box to have the object generate a menu used to populate values in
menus added to other custom objects. The options in the menu are populated by the
values in the lookup eld specied for the object that generates the menu. For example,
 if custom object A generates a menu, you can select the menu to populate a menu eld
you add to custom object B. If object A’s lookup eld is set to Labels, and the object has
three records created for it with labels of “One,” “Two,” and “Three,” the menu in custom
object B that is populated by object A will display values of “One,” “Two,” and “Three.”
Because a menu item is added for each record created for objects that generate a menu,
 you will want to enable this option only for objects that will have few records created for
it.
 

Object Has Display Order Select this check box to make the options in the menu generated by the object sortable
by sequence numbers that you specify when creating records for the object. Selecting
this check box automatically adds a DisplayOrder eld to the object’s table that can then
be added to the object’s workspace.
This option is available only when the Object Generates Menu check box is selected.
 

6. To specify a label for the custom object that is dierent from the name entered in a previous step, enter the
label you want in the Label eld.
Labels are language specic, so you can use dierent labels for interfaces with dierent languages. When an
object is initially named, the object’s label is automatically populated with the object’s name. If the object’s
name is later edited, the label is not automatically updated.

7. To add a description for the custom object, enter the description you want in the Description eld.
Descriptions are language specic, so you can enter dierent descriptions for interfaces with dierent
languages.

8. To add notes about the custom object that you or other sta members can read, such as why the object was
created, click the Notes arrow.

a. Enter the note you want in the text eld.
b. Click Add.
c. To add additional notes, repeat the two previous steps.
d. To delete notes, click Delete for the note you want to remove.
e. To save changes to the notes, click Save.

You can add or delete notes in custom objects even after they are deployed.
9. Click Fields to add predened or customized elds to the object.

10. Click Indices.
The ID eld is indexed by default, as are elds congured to be object lookups. Fields that have the Is In Single-
Field Index option enabled also appear on this page.

Note:  Indexing a eld that is frequently queried can help speed up queries, and you can dene up to
thirty indices per custom object. However, indexing a large number of elds can result in decreased
performance.
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11. To add an index to a eld, click Add New Index.
12. Click Add Field to Index.
13. Select the eld you want to index.

All eld types, except Yes/No and Long Text elds, can be indexed.
The selected eld displays in the List of Indices in Object area.
Each object can have up to eighteen indices for each object. However, this limit also includes indices that are
added automatically for each child eld used in relationships you create for the object. See Custom Object
Relationships.

14. To add a multiple-eld index, select the index you want to edit.
15. Click Add Field to Index.
16. Select the eld you want to add to the index.

Up to four elds can be used in multiple-eld indices.
17. To remove a eld from an index, select the index you want to edit and click Delete.
18. Click Relationships, to dene and view table relationships for the object.
19. Click Extra Options.

Note:  Changes made on the Object Extra Options page take place when you save the object.
Deployment is not necessary.

20. To associate icons with the object to display in the interface, click Browse and select the image you want to use.

◦ 16x16—Icons of this size are used in record tabs on workspaces, the New Workspace window, and the
Workspaces and Scripts explorers.

◦ 24x24—Icons of this size are used on navigation buons.

◦ 32x32—Icons of this size are used on the Insert Fields tab of the workspace designer and in ow
elements on the workow designer.

21. Select the check boxes for the permissions you want to grant to sta members associated with each prole.
These permissions are available for each prole. They can also be dened on the Proles editor.

Field Description

Select All Select this check box to select all permission check boxes for all proles.

Create / Delete / Read / Update Select check boxes in these columns to allow sta members to create, delete, read, or
update records for the custom object.

Personal Notes Select check boxes in this column to allow sta members to create, edit, and delete
notes in custom object records.
This check box displays only for custom objects that have the Notes check box selected
on the Summary page.
 

All Notes Select check boxes in this column to allow sta members with this prole to edit and
delete any notes added to custom object records, regardless of which sta member
added the notes.
This check box displays only for custom objects that have the Notes check box selected
on the Summary page.
 

22. Click Save.
23. Deploy the custom objects.
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Add a Field to a Custom Object  
You add elds to objects and system aributes from the object designer Fields page.

When creating elds, you select the eld type and specify options for the eld that change depending on the type of
eld you create. While the options on the Fields page are similar when editing objects and system aributes, there are
some dierences, which are noted in the procedure.

1. Double-click Object Designer in  Conguration > Database .
2. Select the object or system aribute to which you want to add a eld.
3. Click Fields.

Note:  Each object can contain a maximum of 500 elds, but the actual number of elds you can add
is restricted by the amount of space each eld uses in the database. For example, while an object could
have 500 elds with a Yes/No data type, far fewer elds with a Text data type would be allowed since
text elds use much more space in the database than Yes/No elds.

4. To add predened elds to the object, select the elds you want in the Predened Fields area of the page.
Predened elds are not available for system aributes.

Field Description

Created Time Select this check box to add the CreatedTime eld to the object table. This eld tracks
when custom object records are created and is updated automatically.

Created by Account Select this check box to add the CreatedByAccount eld to the object table. This eld
tracks which sta members create custom object records and is updated automatically.
When you add this eld to a custom object, a relationship to the accounts table is
automatically created.
 

Updated Time Select this check box to add the UpdatedTime eld to the object table. This eld tracks
when custom object records are edited and is updated automatically.

Updated by Account Select this check box to add the UpdatedByAccount eld to the object table. This eld
tracks which sta members update custom object records and is updated automatically.
When you add this eld to a custom object, a relationship to the accounts table is
automatically created.
 

File Aachments Select this check box to add the FileAachments eld to the object table. Add this eld
to allow le aachments to be added to custom object records.
When you add a le aachment to a custom object record, you can change the le
name, but the Description and Display Name properties that can be specied for
aachments added to standard object records, such as incidents, are not available.
 

Labels Select this check box to add the Labels eld to the object table. This eld should be
added if individual records in the custom object require their own visible labels. (For
example, each incident status on your site has a distinct label and each status is a
unique record in the incident statuses table.)

216



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

A separate Label eld is created for each language used on your Oracle Service Cloud
site. This lets you enter a dierent label for each language.
 

Descriptions Select this check box to add the Descriptions eld to the object table. This eld is used
to store text descriptions of records you add to the object.

Notes Select this check box to add a Notes eld to the object table where notes about
individual records can be stored.

5. To add a customized eld to the custom object, click Add New Field.
6. Select the type of data the eld will store.

Data Type Description

Yes/No Select this option to add a eld to store Yes or No values (stored as 1 and 0, respectively,
in the database). Sta members use drop-down menus to enter values in Yes/No elds.

Date Select this option to add a eld to store a date. Sta members can type values in date
elds or select dates using a calendar.

Date/Time Select this option to add a eld to store a date and time. Sta members can type values
in date/time elds or use a calendar to select dates.

Integer Select this option to add a eld to store numeric values (for example, product
or registration numbers). Integer elds can store numbers from -2147483648 to
2147483647.

Text Select this option to add a text eld. Text elds can be congured to store text, email
addresses, or URLs.

Menu Select this option to add a eld with a drop-down menu from which sta members can
select items.
Only one value can be selected at a time in custom object menu elds.
 

7. Enter eld information.

Note:  Some options are disabled when using certain eld types.

Field Description

*Name Enter the name you want for the eld. The name you specify is used in the database. To
specify a dierent display name for the eld, enter a label name in the Interface Label
area, which is also described in this table.
The name cannot exceed 30 characters.
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Field Description

Field Options Select options for customized elds in this area. Some options are disabled for certain
eld types.

Is Auto Update Select this check box to automatically update the eld value when the record is updated.
This option is available only for elds with Date, Date/Time, or Integer data types. Auto-
update elds are read-only.
 

Is Nullable Select this check box to allow null values in the eld. Entering values in elds that allow
null values is optional when editing a record.
Fields in deployed objects that have this option selected cannot be later edited to
remove the option. However, elds in deployed objects can be edited to add this option.
This option is always enabled for system aribute elds.
 

Is Read Only Select this check box to give the eld read-only access. When this option is selected,
values stored in the eld cannot be edited but can be used to display information. A
default value must be specied for elds that have this option selected.
This option is available only for elds with Date, Date/Time, or Integer data types.
 

Is In Single-Field Index Select this option to add an index entry for the eld in cases where the eld is the only
eld in the index. To add a multiple-eld index, click the Indices buon on the ribbon
and perform the steps regarding indices in the Create a Custom Object procedure.
This option is available only for elds with Date, Date/Time, Integer, or Text data types.
 

Yes/No Field Seings Click the Constant Default drop-down menu and select a default value for the eld. The
available options are None, Yes, and No.

Date and Date/Time Field Seings Select options for Date and Date/Time elds in this area.

Dynamic Default Click this drop-down menu to select a value used to dynamically populate the eld.
The dynamic values available for Date and Date/Time elds are the current date or the
current time, respectively. This eld is set to None by default.
Dynamic default values are wrien to a record when the record is saved to the database.
When editing an existing record, the dynamic default value is incremented only when
another eld is edited and the record is saved.
 

Constant Default Enter a value in this area to use as a default for the eld or click the calendar to select a
date from a calendar. When you select a date from the calendar for a Date/Time eld,
 the time is automatically set to 12:00 A.M. If you want a dierent time, you can type it in
the eld.

Minimum Value* Enter a value in this area or click the calendar icon to select the minimum date allowed
in the eld. You can enter dates between January 1, 1000 and December 30, 9999.
This option is available only for Date elds.
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Field Description

Maximum Value* Enter a value in this area or click the calendar icon to select the maximum date allowed
in the eld. You can enter dates between January 2, 1000 and December 31, 9999.
This option is available only for Date elds.
 

Integer Field Seings Select options for integer elds in this area.

Dynamic Default Click this drop-down menu to select a value used to dynamically populate the eld. The
dynamic values available for integer elds are the current sta member’s account ID or
an incremental value. This eld is set to None by default.
Incremental values apply to individual records. All records with dynamic default integer
elds initially have a value of 1 in the eld. In addition, dynamic default values are wrien
to a eld when the record is saved to the database. When editing an existing record, the
dynamic default value is incremented only when another eld is edited and the record is
saved.
 

Constant Default Enter a value in this area to use as a default for the eld. This option is disabled when an
option other than None is selected in the Dynamic Default eld.

Minimum/Maximum Enter the minimum and maximum values allowed for the eld in these elds.

Text Field Seings Select options for text elds in this area.

Field Usage Click this drop-down menu to select the type of text eld you want to create. These eld
types are available:

◦ Plain Text—Select this option to congure the text eld to store from 1 to 255
characters. The maximum number of characters is typed in the Length of Field
eld.

◦ Long Text—Select this option to congure the text eld to store one megabyte of
characters.

◦ Email—Select this option to congure the text eld to store email addresses, up to
80 characters in length. Validation is automatically performed on the text entered
in this type of eld to ensure it corresponds to email paerns dened in the DE_
VALID_EMAIL_PATTERN conguration seing.

◦ URL—Select this option to congure the text eld to store URLs, up to 255
characters in length. Validation is automatically performed on text entered in the
eld to ensure it corresponds to URL paerns.

All text eld types, except Long Text, can be indexed.
 

Length of Field Enter the maximum number of characters that plain text elds can store in this area.
Values from 1 to 255 can be entered.
This option is available only for plain text elds.
 

Paern Enter a regular expression string paern to dene a format that will be used to verify
the contents entered in the eld. The carat (^) character is automatically added to the
start of the paern and the dollar sign ($) character is automatically added to the end.
This ensures that strings entered in the custom object eld match the entire regular
expression.
For example, if you want to create a eld to store phone numbers in a format of
123-456-7890, enter a paern of [0-9]{3}-[0-9]{3}-[0-9]{4}.
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Field Description

 

Note:  This option is available only for plain text and long text elds.

Case Sensitive Sorting Select this check box to recognize case when sorting, with lowercase characters ordered
before uppercase characters in ascending order. For example, if the eld contents
include values of CAT, Cat, cat, and CAt, and case-sensitive sorting is enabled, the
contents will be sorted as cat, Cat, CAt, and CAT.

Defacto Unique for Analytics Select this check box to group the eld contents by the custom object unique key or ID
number rather than the eld values. For example, the First Name eld in the contacts
table is congured to use this option in reports. When running a report that groups
incidents by contacts’ rst names, the report automatically groups by the contact ID
number (contacts.c_id), which is the primary key in the contacts table. This prevents
the incidents submied by all people with the same rst name from being grouped
together.

Menu Field Seings Select options for menu elds in this area.

Menu Click this drop-down menu to select an existing menu eld, menu-only custom object,
or a custom object with the Object Generates Menu option selected to populate the
eld menu options. A read-only relationship to the custom object associated with the
selected menu is automatically created.

Dynamic Default Click this drop-down menu to select a default value for the menu eld that changes
dynamically depending on which sta member uses the eld and which interface the
sta member is logged into. Dynamic default values can be selected for the Accounts By
Group, Accounts By Manager, Interfaces, and Languages menu elds.

Constant Default Click this drop-down menu to select a static default value for the menu eld. The
available options are populated by the options in the menu eld.

Use Current User/Interface/
Language as Default

Select this check box to set the default value of the menu eld to the value that pertains
to the logged-in sta member who is working with the custom object records. This
option displays only when one of these is selected in the menu eld seings drop-down
menu:

◦ Accounts by Manager—When this eld is used, selecting the check box uses the
name of the logged-in sta member as the eld default value.

◦ Accounts by Group—When this eld is used, selecting the check box uses the
name of the logged-in sta member as the eld default value.

◦ Interfaces—When this eld is used, selecting the check box uses the name of the
interface the sta member is currently logged in to.

◦ Languages—When this eld is used, selecting the check box uses the language of
the interface the sta member is currently logged in to.

Interface Label Specify eld names in this section. Dierent labels and descriptions can be used for
interfaces with dierent languages.

*Label Enter the label you want for the eld name in this text box. By default, the name
specied in the Name eld is used as the label. Sta members generally see the eld
label name when working with the eld.
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Field Description

When a eld is initially named, the eld label is automatically populated with the eld
name. If the eld name is later edited, the label is not automatically updated.
 

Description Enter an optional description for the eld in this text box. The description displays as a
tooltip when viewing the eld in workspaces or the report designer.

8. To make a text or integer eld a lookup eld for an object, click the option in the Object Lookup column.

This option is not available for system aribute elds. The eld dened as the object lookup is automatically
added as a single-eld index to the object. If you do not specify a lookup eld, the ID eld is automatically
selected as a lookup eld. If you select the Labels check box on the Fields page, the Labels eld that is added to
the object is automatically selected as the object lookup eld.

Lookup elds help identify records when you’re working with them. Values in lookup elds are displayed on
the editor tab when you’re editing records and in the Recent Items list on the navigation pane. For example,
when editing an incident, the incident reference number displays on the editor tab since Incidents.Reference #
(incidents.ref_no) is congured as a lookup eld in the database. In addition, lookup eld values are displayed
in reports for elds in other tables that join to the lookup eld. For example, if you create an object with a Name
eld designated as the lookup eld, then dene a relationship to another object with a NameID eld and use
this eld to join the objects, and then run a report with NameID as an output column, the values in the Name
eld will be displayed in the column.

In addition, lookup eld values are displayed in reports for elds in other tables that join to the lookup eld. For
example, if you create an object with a Name eld designated as the lookup eld, then dene a relationship to
another object with a NameID eld and use this eld to join the objects, and then run a report with NameID as
an output column, the values in the Name eld will be displayed in the column.

9. To delete a eld, click X.

10. To edit an existing eld, select the eld in the list of elds and make the changes you want.
Most elds in deployed custom objects can still be edited, though some options may be disabled for certain
eld types.

11. Click Save.

Custom Object Relationships  
The relationships that you dene for your objects determine if the data in the objects can interact with data in other
custom objects or standard objects.

Objects must be related to use elds from one object on another object’s workspace. For example, if you want elds
from the incidents table to be available for use on a custom object’s workspace, the incidents table must have a
relationship with the custom object.

When relationships are dened, objects are either parents or children of the object you are editing. Most custom objects
and standard objects can be either parents or children of other custom objects. Relationships can be made to these
standard objects:

• Accounts

• Answers

• Assets
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• Community Comment

• Community Question

• Community User

• Contacts

• Incidents

• Opportunities

• Organizations

• Quotes (cannot be a parent in relationships)

• Sales products (cannot be a parent in relationships)

• Tasks

Note:  Relationships between the quotes and opportunities standard objects are not supported.

Whether you are dening parent or child relationships, two types of relationships are available:

• Aggregation—This creates a close relationship between records in the objects. Use this type if you want records
in the child table to be automatically deleted when their parent record is deleted from the parent table. For
example, incidents belonging to a contact are deleted when the contact is deleted. If several tables are joined
with aggregation relationships, deleting a record in the parent table automatically deletes all related records in
the other tables.

• Association—This creates a loose relationship between records in the objects. Use this type if records in the
child table should not be automatically deleted when their associated records in the parent table are deleted.
For example, deleting a sta account does not delete incidents created by the account.

When you dene relationships between objects, they are joined by integer elds that contain unique values (the eld
contains a unique value for each record in the object). Each custom object can have one such eld. For example,
incidents are linked to contacts using the Incidents.Incident ID (incidents.i_id) and Contacts.Contact ID (contacts.c_id)
elds. These are both integer elds that contain unique values.

Note:  Relationships to menu-only objects are automatically created when the menu-only object is used to
populate menu elds in custom objects. These relationships cannot be manually deleted, but are deleted
when the menu-only object is no longer used to populate menu elds or when the menu-only object is
deleted.

Relationship Restrictions  
Before you create relationships, it is important to be aware of constraints in the relationships you can add to an object.

• A maximum of 18 indices can exist for each custom object. This limit includes indices you create as well
as indices that are created automatically. An index is added automatically for each child eld used in a
relationship.

• Aggregation relationships have limits that do not apply to association relationships:

◦ A maximum of ve aggregation relationships can be created for each object.

◦ A maximum of four objects can be joined using consecutive aggregation relationships where each object
is a parent of another, with object A being the parent of object B, which is the parent of object C, and
so on. This limit does not apply to read-only relationships that are automatically created when certain
standard menus are used to populate menu elds in the custom object.
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◦ Self-referencing relationships cannot be congured for aggregation relationships.

Dene a Relationship  
Dene a relationship for a custom object.

1. Double-click Object Designer in  Conguration > Database .
2. Select the object or system aribute you want to edit relationships for or create a new object.
3. Click Relationships.
4. Click Add, to add a Parents of Object relationship or a Children of Object relationship.

a. Click Type.
b. Select the type of relationship.

- Aggregation—Use this relationship type if you want records in the child table to be automatically
deleted when their parent record is deleted from the parent table. For example, incidents belonging
to a contact are deleted when the contact is deleted.

- Association—Use this relationship type if records in the child table should not be automatically
deleted when their associated records in the parent table are deleted. For example, deleting a sta
account does not delete incidents created by the account.

c. Click Parent Object or Child Object.
d. Select the object you want to link to.
e. If creating a parent relationship, click Child Field.
f. Select the eld in the object you are editing that you want to use as the link to the parent object.

If the object does not have a eld that you can use as the link, or if you don’t want to use one of the
existing elds, you can select Auto Generate New to have an integer eld created automatically. The new
eld will then be added to the object you are editing, and will be used as the link to the parent table. You
can view the new eld on the object’s Fields page.

g. If creating a child relationship, click Child Field.
h. Select the eld in the child object that you want to use as the link to the object you are editing.

Note:  If the child is a standard object, you will need to select an integer or menu system aribute
that has been created for the standard object. If a system aribute does not exist, or if you want
to use a dierent system aribute, select Auto Generate New. A new system aribute with an
integer data type will automatically be created for the standard object.

5. If you create more than one relationship to the same object, select the option in the Main column next to the
relationship you want to use as the main relationship between the object and the custom object.

6. To delete a relationship, click Delete.
7. To edit an existing relationship, click  Edit Relationship > Edit .
8. Click Save.

This also saves any system aributes that have been automatically created for standard objects in the steps
above.

Self-Referencing Relationships  
Self-referencing relationships can be dened for custom or standard objects that are joined by association relationships.

Self-referencing relationships are congured to make an object a parent or child of itself. Workspaces for objects with
self-referencing relationships can include relationship items for the object. For example, an incident workspace that
includes the Incidents View relationship item can be used to associate one incident with another.

This type of conguration gives you a wide range of customization options. For example, if you have a relationship in
which the incidents object is a parent of itself, you can congure incident workspaces to let you create sub-incidents or
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related incidents to help you track incidents related to the same issue. Or, if contacts is made a parent of itself, you can
create contact workspaces that allow links to other contacts, such as customers living in the same residence.

Related Topics
• Custom Objects on the Service Console

Create a System Aribute  
System aributes are custom elds on standard objects, and are created and managed from the object designer. You
can create system aributes for accounts, answers, assets, contacts, incidents, opportunities, organizations, quotes,
sales products, and tasks.

A combined maximum of 500 system aributes and custom elds can be created for each standard object. That is, if
you have 100 incident custom elds, you could create 400 system aributes for the incident object. In addition, each
standard object can have a maximum of 18 system aributes and custom elds that are indexed.

1. Double-click Object Designer in  Conguration > Database .
2. Select the package where you want to place the system aribute.
3. Click  New > System Aribute , and then select the standard object for which you want to create the eld.

The Object Fields editor displays, with the list of elds (system aributes) for the object.
4. Click Add New Field, then select the eld type.
5. Enter the elds.

Field Description

*Name Enter a column name for the eld up to 30 characters long. The name cannot contain
spaces.

*Package Select an existing package, or click Add Package.

Field Options Select eld options:

◦ Is Auto Update

◦ Is Nullable

◦ Is Read Only

◦ Is In Single Field Index

Depending on the eld type, not all of the check boxes are enabled.
 

Field Seings These vary depending on the eld type. For example, text elds have Field Usage and
Length of Field seings.

*Label Enter a label if desired. The eld name is the default.

Description Enter a display name for the eld.

6. To dene relationships for the system aribute, click Relationships.
7. Follow the procedure described in Custom Object Relationships.

This step is optional for system aributes. If you need to dene a relationship to a custom object, you can do so
when editing the object.
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Note:  Relationships between the quotes and opportunities standard objects are not supported.

8. To dene indices for the system aribute, click Indices.
9. Perform the steps regarding indices in the Create a Custom Object procedure.

Adding indices to system aributes is optional.
10. Click Save.
11. Click Deploy.

After you deploy the system aribute, it can be used in reports, workspaces, and custom objects, and you can manage
and edit the system aribute from the object designer.

Related Topics
• Custom Object Relationships

• What to Do with Custom Objects After Deployment

• Create a Custom Object

• Deploy Custom Objects

Menu-Only Custom Objects  
Menu-only custom objects store menu options for populating menu elds in other custom objects. This lets you to use
the same menu lists to populate menu elds in multiple custom objects.

In addition, because management of items in menu-only objects is handled from the Customizable Menus tree, it is
simple to add, edit, or delete items in the menus whenever you need.

For example, if you were creating a product registration solution, you could create a menu-only object that lists
locations where customers can purchase your products. You could then create another custom object that stores when
the product was purchased, who purchased it, and where they purchased it. You could use the menu-only object to
populate the menu eld that tracks where the product was purchased.

Conguring menu-only custom objects is straightforward since all conguration is performed on the object designer
Summary page. Ribbon buons to access the Fields, Indices, Relationships, and Extra Options pages are disabled. You
don’t need to congure relationships to menu-only objects since they are created automatically when you use the
menu-only objects to populate menu elds in other custom objects.

Note:  Changes to menu items in a deployed menu-only object are performed using the Customizable Menus
conguration item. After a menu-only object is deployed, it is treated the same way as other menu objects,
such as industry types or incident queues.

Create a Menu-Only Custom Object  
You can create a custom menu-only object.

1. Double-click Object Designer in  Conguration > Database .
2. To create a package for the object, click  New > Package .
3. Enter the name you want for the package.

Package names must be eleven characters or less.
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Note:  You can also add custom objects to the default CO package. Package names are used
in the names of tables created in the database for custom objects. For example, if you create a
WarrantyMenu object in the CO package, the resulting table name will be CO$WarrantyMenu.

4. Select the package you want to add the custom object to.
5. Click  New > Menu Only Object .
6. Enter a name for the object in Name.

The name you dene identies the object in the database. Sta members generally see the custom object’s
label, dened below, when working with the object. Object names must start with a leer, cannot contain
special characters other than the underscore character (only single underscores are allowed), and cannot
contain more than twenty characters. In addition, certain words cannot be used as object or eld names since
they are reserved for use by other processes. If you aempt to save an object that uses a reserved word, a
validation message informs you that the name must be changed.

7. Click Add.
8. Click the new row and then enter a name for the menu item.
9. Repeat steps 7 and 8 to add other menu items.

10. To add language-specic labels to the menu items, click Convert to Menu with Labels.
This action cannot be undone and it cannot be selected after the object is deployed. Use this option if your site
has interfaces with dierent languages.

a. Click Show Label Grid, to display the label grid.
b. Enter the text you want to display for the menu item for each interface in the grid’s Label eld.
c. To hide the grid, click Hide Label Grid.

Note:  After menu-only objects with labels are deployed, you can modify the text for the labels by
editing the objects from Customizable Menus.

11. To change the ordering of the menu items in the list, click the up or down arrow next to the name of the item
that you want to move.

12. To specify a label for the custom object that is dierent from the name entered in step 6, enter the label you
want in the Custom Object Labels Label eld.
Labels are language specic, so you can use dierent labels for interfaces with dierent languages. When an
object is initially named, the object’s label is automatically populated with the object’s name. If the object’s
name is later edited, the label is not automatically updated.

13. To add a description for the object, enter the description you want in the Custom Object Labels Description
eld.
Descriptions are language specic, so you can use dierent descriptions for interfaces with dierent languages.

14. To add notes about the custom object that you or other sta members can read, such as why the object was
created, click the Notes arrow.

a. Enter the note you want in the text eld.
b. Click Add.
c. To add additional notes, repeat steps 14.a and 14.b.
d. To delete notes that have previously been added, click Delete.
e. To save changes to the notes, click Save.

You can add or delete notes in custom objects even after they are deployed.

Use a Menu-Only Object in a Custom Object  
You can create a menu-only object in a custom object.

1. Edit the custom object that will use the menu eld.
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Tip:  In addition to populating menu elds in objects, you can use menu-only objects to populate the
options for system aributes with menu data types.

2. Click Fields .
3. Edit or add a menu eld to the custom object.
4. Click  Menu Field Seings > Menu  and select the menu-only object you created.
5. Click Save.
6. Deploy the custom objects when you are ready.

Edit or Delete a Custom Object  
Before custom objects are deployed, you can change any part of their conguration or delete them without impacting
the database since they have not been wrien to the database.

If you make numerous changes to custom objects that you later choose not to deploy, you can roll back the changes
and the custom objects will revert to the state they were in at the time of the previous deployment (if the custom objects
have never been deployed, all custom objects are removed).

After deploying custom objects, you can still update or delete them if necessary, although you must then redeploy them
to implement the changes to the database. We recommend redeploying custom objects only if necessary since the
database will be altered.

There are some important considerations to keep in mind before you delete custom objects or elds in custom objects.

• Deleting custom objects that have relationships to other objects results in the relationships also being deleted.

• Deleting elds in custom objects that are used in relationships will also delete the relationships.

• Deleting elds from custom objects that are used in indices will also delete the indices, whether they are single-
eld or multi-eld indices.

• When you delete menu-only custom objects that are used in menu elds in other custom objects, those menu
elds are also deleted.

Note:  Sta members with the Bulk Delete permission enabled can delete up to 1000 custom object records
at a time. See Administration Permissions and Bulk Delete.You can create custom data lifecycle management
policies for archiving and purging custom objects. See Data Lifecycle Management.

1. Double-click Object Designer in  Conguration > Database .
2. To edit a custom object, select the object in the Custom Objects list and make your changes.

Note:  To edit items in a menu-only custom object that has been deployed, use the Customizable
Menus conguration item. After a menu-only object is deployed, it is treated the same way as other
menu objects, such as industry types or incident queues.

3. To delete a custom object, select the object in the Custom Objects list and click Delete.
4. Click Yes.

a. To restore the deleted custom object, click Undelete.
This buon is disabled if the custom object was not previously deployed.

5. Click Save.
6. Deploy the custom objects.
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7. Close the object designer.

If you aempt to close the object designer without saving your changes, a Data Modied message displays
asking if you want to save the changes. If you select No, all changes to your objects will be lost.

Roll Back Changes to Custom Objects  
If you make numerous changes to custom objects that you later choose not to deploy, you can roll back the changes.

The custom objects will revert to the state they were in at the time of the previous deployment.

Note:  If the custom objects have never been deployed, they are removed.

1. Double-click Object Designer in  Conguration > Database .
2. Click Rollback.
3. Click OK.

Deploy Custom Objects  
After you create custom objects, you must deploy them to apply the changes to the database.

When you deploy custom objects, the database is updated to add new elds, tables, relationships, and indices for the
custom objects, so it is important that they are correct before you deploy them.

When a deployment occurs, the object designer is unavailable until the deployment completes so you should carefully
consider when to deploy to ensure your site is not negatively impacted. Use the Deploy Immediately option with care on
production sites. An email is sent to a specied address upon completion or if the deployment fails to complete.

When you deploy custom objects, all custom objects in all packages are deployed. Custom objects that have previously
been deployed will be examined for changes. If no changes have been made to those objects since the previous
deployment, the objects are ignored during deployment.

During deployment, several tasks are performed that can take some time. The custom objects are rst wrien to a
le, and then the database is updated to add the tables, elds, indices, and keys for your custom objects. Given how
intensive this process is, deploying on your production site should be performed after business hours or when work on
the site is at a minimum. You can schedule deployments to occur when you want and you can specify the maximum
amount of time that can be granted to the deployment, so scheduling a deployment for o-peak times is easy.

1. Double-click Object Designer in  Conguration > Database .
2. Click Deploy.
3. Enter the email addresses you want to send notications to in the Email Address eld.

Separate multiple addresses with commas.
4. Specify when you want the deployment process to begin.

The amount of time required for deployments varies signicantly depending on a number of factors, including
the number of custom objects being deployed, the elds they contain, and the relationships that must be
created. In general, deploying new custom objects takes less time than re-deploying existing custom objects to
modify or add elds, since the tables for existing custom objects may contain large numbers of records that will
need to be updated.

a. To immediately deploy all custom objects, select Deploy Immediately.
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b. To specify a time when you want the deployment process to start, enter the date and time you want the
deployment to begin.
You can either enter the date and time you want or you can click the calendar next to the eld and select
the date for the deployment. The default time is the current time, adjusted for the time zone dened in
your sta account. The start time can be no more than forty-eight hours past the current time.

c. Click Cutover Window and select the amount of time after the cutover start time that the deployment
process can start.
The process may not start immediately at the specied cutover start time due to issues that prevent
the cutover from starting such as the database being unavailable or a utility being unable to run. If the
cutover cannot start during this window, the deployment process is halted. If the deployment process
fails to begin during the cutover window, you will need to open the object designer and select the
deployment options again. No other options are available on the object designer until deployment
completes.

5. Click Deploy.
6. Click Yes.

After custom objects are deployed, new workspace types are made available for objects that have the Object is Available
in Workspaces, Scripting, and Workow option enabled so you can work with them in the same way you work with
incidents or contacts. In addition, standard reports are automatically created for deployed objects that have this option
enabled.

Export and Import of Custom Objects  
Before you deploy custom objects on your production site, we recommend that you rst test them on a test site that is
similar to your production site. This helps ensure that the custom objects function as expected and interact with other
data in your site the way you want.

After verifying that the custom objects are congured correctly on the test site, you can export the objects from the
test site and then import them into your production site. The imported objects will include all the elds, indices, and
other aributes originally congured for them. The relationship conguration of the objects is also included if all of the
related custom objects are exported and imported.

Note:  Only custom objects that have been deployed can be exported. In addition, only system aributes,
menu-only objects, and objects that have the Object is Available in Workspaces, Scripting, and Workow
option selected can be exported. Because a maximum of 23 custom objects can be imported at a time (not
including menu-only objects), we recommend exporting no more than 23 custom objects at a time. Multiple
export les can be created and then imported.

Export Custom Objects  
You can export custom objects from a site.

Verify that the custom objects are congured correctly on a test site.
1. Double-click Object Designer in  Conguration > Database .
2. Click Export.

Packages that do not contain deployed objects are disabled and cannot be selected for export.
3. Click the arrow next to a package to display the objects in the package and then select the check boxes next to

the objects you want to export.
a. To select all the objects in the package, select the check box next to the package name.

4. Click Next.
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5. If the objects selected for export have aggregate child relationships to other custom objects that are not
selected for export, the next page of the wizard gives you the option to also include the parent custom objects
in the export.

a. Clear the check boxes next to the objects you do not want to export. By default, custom objects that are
aggregate parents of objects selected for export will also be exported.

6. Click Next.
7. Enter the path and le name to which you want to save the export le.
8. Click Finish.
9. To export additional objects, which you may need to do if exporting more than 23 objects, repeat steps 2

through 8.
10. Close the object designer.

Import Custom Objects  
After exporting custom objects from a test site, you can then import them into your production site.

1. Double-click Object Designer in  Conguration > Database .
2. Click Import.
3. Enter the path and le name of the le to import.
4. Click Next.

If you import objects with the same package and object names as existing objects on the site, you can either
merge the imported objects with the existing ones or create new objects with dierent names. If you choose
to merge the objects instead, the existing object is updated to include additional elds that are in the imported
object. No changes are made to elds in the existing object that are not in the imported object.

Note:  Menu-only objects and system aributes cannot be merged. When these are imported into a
site that has matching items with the same names, the imported custom objects will automatically be
given new names.

5. Select options for the imported objects.
a. To create a new custom object instead of merging a custom object, click  merged into the existing

custom object > imported as a new custom object . A default name for the new object displays next to
the drop-down menu. Click the default name and enter a new name in the text box to dene a dierent
name.

b. To prevent a custom object from being imported, clear the check box. To clear the check boxes next to all
custom objects, click Unselect All.

If you clear the check boxes next to objects with a parent-child relationship and then add the child object back
to the import, the parent objects check boxes are selected automatically. This ensures that all objects required
for a relationship are included in the import. You can then clear the check boxes next to the parent objects if
you do not want to import them.

6. Click Finish.
7. To import additional objects, which you may need to do if importing more than twenty-ve objects, repeat

these steps.
8. To deploy the imported objects on your site, click Deploy.
9. Close the object designer.
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What to Do with Custom Objects After Deployment  
After deploying custom objects, they are treated in the same way as standard objects and custom elds. However,
before you can work with custom object records or report on them, you must perform some additional steps.

• Create workspaces your sta members will use to work with custom object records. See Custom Objects on the
Service Console.

• Add reports to your sta members’ navigation sets so they can create and access custom object records. See
Custom Objects in Navigation Sets.

• Edit proles to specify permissions for sta members to use the custom object workspaces and work with the
object records. See Custom Object Permissions in Proles.

• Create some custom reports to track information about your custom object data, such as when records are
created, the number of records created, and which sta members worked with them. See Custom Objects in
Analytics.

• If you create custom objects to import existing information stored in an external database into Oracle Service
Cloud, use the Data Import Wizard  to copy the information into your site. See Custom Objects in the Data
Import Wizard.

Custom Objects on the Service Console  
Deployed custom objects can be added to your Service Console components, including workspaces, workspace rules,
workows, and agent scripts.

Using objects and system aributes in these areas is no dierent from using standard objects and custom elds.
However, where default workspaces are automatically created for standard objects, workspaces are not automatically
created for custom objects so you need to create them so your sta members can add and edit records for your custom
objects.

When creating workspaces for custom objects, the Insert Field tab on the workspace designer’s ribbon gives you access
to the custom object’s elds as well as elds of objects that are parents of the custom object.

In this example, the workspace is being created for the WorkOrder custom object. Since incidents and the Service
Category custom object are both parents of the WorkOrder custom object, the elds from the parent objects can also be
added to this workspace.

If an object is the child of another object in a relationship, and if both objects can have workspaces created for them,
you can edit the parent object’s workspace to add a relationship item for the child object. The names of the relationship
items for child objects are derived from the object’s label followed by “View” (for example, a relationship item for an
object named Warranty will be named Warranty View). This relationship item lets you access the child object’s records
while working with a record for the parent object. For example, you can add the Incident View relationship item to a
contact workspace to let you access incidents when viewing a contact record.

Note:  If the same object is added as a child in multiple relationships to the same parent (for example, if
the contacts object is specied as the child of the incidents object in two relationships), the workspace
designer’s ribbon will still contain only one view item for the object. However, when you add the view item
to a workspace, you can specify which report to use for the view item. This lets you dene which of the child
relationships the view item will use.

If you have created a self-referencing relationship between objects, such as making incidents a child of itself, you can
add a view item for the object to the object’s workspace. This conguration lets you create parent/child associations
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between dierent records for the same object. For example, adding the Incidents View item to an incidents workspace
lets you create or edit a child incident when editing the parent incident.

Tip:  Browser controls added to workspaces can include variables in the URLs to pass information about
custom object records to a web page. The variable has a format of $package_name$object_name.eld_name.
For example, to pass information about a eld named PaymentType in an object named WorkOrder in the CO
package, append $CO$WorkOrder.PaymentType to the browser control’s URL. Refer to the Oracle Service Cloud
Connect Desktop Integration (Javascript API) documentation available at our support site.

Related Topics
• Custom Object Relationships

Custom Objects in Navigation Sets  
Sta members who require access to custom object records must be able to open the records from their navigation set.

Custom reports that are congured to let you open custom object records can be added to navigation sets, and options
to create new custom object records can be added to the le menu using the Navigation Sets editor.

In addition, you can add standard search reports to navigation sets to help you quickly locate specic custom object
records. These reports are automatically created for all deployed custom objects and are located in  Public Reports >
Common > Views—Common > Search Reports—Custom Objects .

Custom Object Permissions in Proles  
The workspaces or workows you want to use to create and edit custom object records are specied in your prole.

You specify workspaces or workows for custom objects in the same way that you associate customized workspaces to
edit incidents or other standard objects.

In addition to associating workspaces or workows with custom objects, you need to specify permissions for your sta
members to read, delete, and perform other actions on custom object records. Each deployed custom object is listed on
the Custom Objects tab of the Proles editor.

The custom objects are organized by the package they are in. Similar permissions can be granted for each object,
though the Notes permissions are available only for objects with elds that have notes.

Related Topics
• Proles

• Custom Objects Permissions

Custom Objects in Analytics  
Deployed objects that have the Object is Available in Workspaces, Scripting, and Workow option enabled automatically
have standard reports created for them.

You can nd the reports in  Public Reports > Common > Views—Common > Search Reports—Custom Objects 
and Editor Reports–Custom Objects. These reports are primarily intended to be used as Quick Search reports and in
workspaces to provide access to the custom object records.

All deployed custom objects are available for use in custom reports, so you can create the custom reports you need to
track your data. Using custom object data is no dierent than using data in standard tables, with the exception that data
in menu-only custom objects is not available for inline editing.
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When creating reports in the report designer, you can nd your custom objects in the data dictionary. The elds created
for system aributes and the tables created for objects each have unique naming conventions (these conventions
are also followed when viewing custom objects in the Data Dictionary located in  Conguration > Database > Data
Dictionary ).

• System aribute elds—Fields created for system aributes are listed in the table they are associated with,
just as custom elds are. However, where the database names for custom elds are prepended with c$, the
database names for system aributes are prepended with the name of the package they are in followed by
the dollar sign. For example, after creating an incidents system aribute named ManagerReviewed in the CO
package, a eld named “Manager Reviewed (CO$ManagerReviewed)” will display in the incidents table.

• Object tables—Tables that store object data are listed by the object label names. The table database names
are derived from the name of the object, prepended with the name of the package and the dollar sign ($). For
example, an object in the CO package that is named ProdReg with a label of Product Registration displays in the
data dictionary as “Product Registration (CO$ProdReg).”

Tip:  To use custom object transactional data in a custom report, you need to use elds from the Custom
Object Transactions (co_trans) table instead of the Transactions (trans) table.

Custom Objects in the Data Import Wizard  
You can use the Data Import Wizard to import a large number of records into your custom objects from an external le.

After deploying custom objects and conguring workspaces, navigation sets, and other components, you can enter data
in the custom object records just like you enter information for individual incidents, contacts, or tasks.

However, you can also use the Data Import Wizard to import a large number of records into your custom objects from
an external le. Data can be imported into objects as well as system aributes. Because custom objects are used to
integrate your organization’s unique data into Oracle Service Cloud, you will likely want to consider using this option to
copy data from an external database into your site.

Custom Processes  

Overview of Custom Processes  
Custom processes are predened object event handlers (PHP scripts) that run as the result of an event occurring on
standard or custom objects.

Object event handlers can help your organization automate tasks based on the events that trigger them. For instance,
when an incident is updated, an object event handler can be triggered to update a record in an external system. Event
handlers can also be used in rules, surveys, and campaigns.

Object event handlers are added and managed on the process designer in a virtual container called the process model.
After you add your object event handlers, you must deploy the process model to use the object event handlers in Oracle
Service Cloud. The process model is not wrien to the Oracle database until it is deployed.

We recommend testing the process model in a non-production site. When you are nished testing the process model,
you can export it from your non-production site, import it into your production site, and then deploy it. For more
information, see Best Practices for Testing Object Event Handler Scripts.
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Note:  The process designer interacts with the Connect Common Object Model (CCOM), which is publicly
accessible and backward compatible. The CCOM can also be accessed using these APIs:

• Connect PHP API

• Connect REST API

• Connect Web Services for SOAP

Process Designer  
You use the process designer to add object event handlers and deploy process models to the Oracle database.

To access the process designer, your prole must have the Process Designer permission on the Administration tab
enabled. See Administration Permissions. In addition, you might need to add the Process Designer component to your
navigation set to view it. See Create a Navigation Set for the Administrator.

CAUTION:  Due to the high degree of workow change that can be made to your application when using
custom processes, we recommend that few sta members be granted access to the process designer.

When you open the process designer, you will notice that the tree includes a list of standard objects under the
OracleServiceCloud entry and custom objects under the CO package or other packages you create in the object
designer. Only deployed custom objects are available on the process designer (see Create a Custom Object and Custom
Object Packages.)

The objects shown in the tree can be associated with the event handlers you add using the process designer. If you
intend to use event handlers in rules, surveys, or campaigns, you do not need to associate them with objects. See
Triggers for Object Event Handlers.

Object Event Handlers  
Object event handlers are available for both custom objects and standard objects.

Custom object event handlers act on custom objects, whereas standard object event handlers act on standard objects in
the Connect Common Object Model, including Answer, Contact, Incident, Opportunity, and Organization.

Note:  When creating an object event handler, required test harness code must be implemented in the PHP
script to ensure compatibility with Oracle Service Cloud. See Example of an Object Event Handler Script.

You can also add event handlers to use in rules, surveys, and campaigns. These event handlers do not need to be
associated with the objects listed on the process designer. See Triggers for Object Event Handlers.

Best Practices for Testing Object Event Handler Scripts  
Before you add an object event handler, we recommend reviewing our best practices to ensure that you are aware of
potential issues. These best practices can be helpful when creating and testing object event handler scripts.

• Have a complete test in mind. Consider all of the expected conditions and eects of the object event handler
script and test for them in the test harness.

234

http://documentation.custhelp.com/euf/assets/devdocs/cloud19d/Connect_PHP/Default.htm
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/cxsvc/
http://documentation.custhelp.com/euf/assets/devdocs/cloud19d/Connect_Web_Services_for_SOAP/Default.htm


Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

• Handle expected and possible errors with try/catch statements.

• Consider selecting the Can Suppress check box on the process designer or including SuppressExternalEvents in
a ->save in your script. If neither of these steps is performed, the script might re-enter itself in an innite loop.

• Consider the test harness when integrating with external systems. For instance, the $run_mode parameter and
the apply() method of your object event handler script can be tested to determine whether they are being run
as part of a test or not. You must decide how to test against external integrations or systems.

• Objects passed after an edit contain only the data that was modied during the edit. For instance, if an incident
thread is modied during an edit, only that thread is passed. Other data associated with the object (such as
other incident threads) needs to be passed using a new instance of the object.

• Object event handler script headers include Package: and Objects: tags. The package tag denes the package
where you place the script rather than the package where the objects are located. The objects tag denes which
objects the event handler impacts. You must list the objects using their PHP names. For instance, if you have a
custom object named Warranty located in the CO package, the object’s name in the tag will be CO/Warranty.

• Custom processes do not aect the behavior of PHP global variables. See  Variable scope  in the standard PHP
documentation.

• When testing an object event handler script before deployment:

◦ Any regular or error output displays in a dialog when the test is complete.

◦ Any errors encountered prevent the State eld from being marked Tested.

◦ Any errors encountered within the test harness are not logged and are not counted against the runtime
errors of a deployed script.

• When testing an object event handler script after deployment:

◦ Any deployed object event handler script that encounters ve errors (without any intervening success)
will be disabled and the status of the State eld will be changed to Errored. Otherwise, the script will
become disabled on or after the fth run if the error:success ratio becomes greater than or equal to 50%.

◦ Error and success rates will stop recording when the error:success ratio falls below 10%.

◦ All runtime errors are recorded to the Info log. See Log File Errors and Information.

Add an Object Event Handler  
Using the process designer, you can create a new object event handler.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Process Designer.

The process designer opens on the content pane.
3. Click New.

The Server Process Object Event Handler editor opens.
4. Enter a name for the object event handler in the Procedure Name eld.

Object event handler names must start with a leer, end with a leer or number, and contain only leers,
numbers, and underscores.

5. Click the folder icon next to the PHP Code File eld and select a le to load.
The Procedure Name eld is then updated with the name of the le in the PHP Code File eld, the State eld
displays Requires Save, and all PHP code displays as read-only in the PHP Content eld.

Tip:  We recommend that you name your PHP code le according to its event function or manually
update the Procedure Name eld after loading the le.

6. To execute the event handler asynchronously, select Execute Asynchronously. (This option is selected
automatically if the PHP script includes the async keyword.)
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This option schedules the event handler to execute using a queuing system. If the rst aempt fails for some
reason, such as a server being unavailable, the event handler execution will be retried automatically up to
four times. The rst retry occurs 90 seconds later, the second occurs 450 seconds later, the third occurs 3,150
seconds later, and the fourth occurs 34,650 seconds later.
You can use this option with an event handler that does not need to execute immediately and that is not
required by the operation that triggered the event. For instance, if you have an integration that updates contact
information in an external database when a contact is created in Oracle Service Cloud, you can use an async
event handler since the data can be sent any time.

Note:  You must select the Execute Asynchronously check box if you use cURL commands in your
event handler. Do not select this option if you are adding an event handler for use in surveys or
campaigns.

7. Click Save.
The status of the State eld changes to Not Tested and the Test buon is enabled.

8. Click Test below the State eld to test the PHP code le for errors and to verify the test harness.
If no errors are encountered and your test harness validates, a message displays and asks if the object event
handler test result was correct.

9. Click Yes to acknowledge that the test ran as you expected.
The message closes, the status of the State eld changes from Not Tested to Tested, and the Test buon is
disabled.

10. Click Save to save the process model.
11. Associate the event handler with an object and event type that will trigger it.

This step is not needed when creating event handlers to use in rules, surveys, or campaigns. See Triggers for
Object Event Handlers.

Before you can use the object event handler, the process model must be tested and deployed. See Deploy the Process
Model and Roll Back the Process Model.

Example of an Object Event Handler Script  
This example object event handler script adds a note to an organization when it is created in the Oracle database.

The types of objects and actions with which the script can function are indicated at the beginning of the script. The
required test harness code is located approximately halfway through the script.

Note:  An additional sample script that uses client for URLs (cURL) to perform an action in an external
database is provided in the Connect PHP API Developer Guide.

 <?
 /*
 * CPMObjectEventHandler: organization_create
 * Package: OracleServiceCloud
 * Objects: Organization
 * Actions: Create
 * Version: 1.1
 */
 // This object procedure binds to v1_1 of the Connect PHP API
 use \RightNow\Connect\v1_1 as RNCPHP;
 // This object procedure binds to the v1 interface of the process designer
 use \RightNow\CPM\v1 as RNCPM;
 /**
 * An Object Event Handler must provide two classes:
 * - One with the same name as the CPMObjectEventHandler tag
 * above that implements the ObjectEventHandler interface.
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 * - And one of the same name with a "_TestHarness" suffix
 * that implements the ObjectEventHandler_TestHarness interface.
 *
 * Each method must have an implementation.
 */
 class organization_create
 implements RNCPM\ObjectEventHandler
 {
 public static function
 apply( $run_mode, $action, $obj, $n_cycles )
 {
 $note = new RNCPHP\Note;
 $note->Text = "\n".date(DATE_RSS)."\n"
 ."\nA note added by " . __CLASS__
 . '::' . __FUNCTION__ . "\n";
 if (is_null($obj->Notes))
 {
 $obj->Notes = new RNCPHP\NoteArray;
 }
 $obj->Notes[] = $note;
 $obj->Name = preg_replace( '/^[aA]n* /', 'The ', $obj->Name );
 
 // Do not suppress because we want the update flow to run.
 $obj->save();
 return;
 } // apply()
 } // class organization_create
 /*
 The Test Harness
 */
 class organization_create_TestHarness
 implements RNCPM\ObjectEventHandler_TestHarness
 {
 static $org_invented = NULL;
 public static function setup()
 {
 // For this test, create a new organization as expected.
 $org = new RNCPHP\Organization;
 $org->Name = "An organization name";
 $org->Login = "a login";
 static::$org_invented = $org;
 return;
 }
 public static function
 fetchObject( $action, $object_type )
 {
 // Return the object that we want to test with.
 // You could also return an array of objects
 // to test more than one variation of an object.
 return(static::$org_invented);
 }
 public static function
 validate( $action, $object )
 {
 // Add one note.
 return(count($object->Notes) === 1);
 }
 public static function cleanup()
 {
 // Destroy every object invented by this test.
 // Not necessary since in test
 // mode and nothing is committed,
 // but good practice if only to
 // document the side effects of this test.
 static::$org_invented->destroy().
 static::$org_invented = NULL;
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 return;
 }
 }

Triggers for Object Event Handlers  
Using the process designer, you can associate an event handler with a standard or custom object and a create, update,
or destroy action.

After adding an event handler to the process designer, you must specify how the event handler will be triggered. Only
event handlers specically wrien for the object type and action can be selected when making these associations.

Object event handlers can also be triggered by rules, surveys, and campaigns when the conditions you specify are met.
For information about using event handlers in rules, see Actions for Rule Bases.

Note:  Only object event handlers wrien for contacts can be used in surveys and campaigns.

You can also use the process designer to associate event handlers with create, update, or delete actions performed
on standard and custom objects. When the action occurs on the associated object, the event handler is triggered
automatically. The event handler must be wrien to work with the associated object and action.

For example, this Example of an Object Event Handler Script is triggered when organizations are created.

Associate an Event Handler with an Object  
Use the process designer to associate object actions with event handlers.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Process Designer.

The process designer opens on the content pane.
3. Select the custom or standard object that you want to associate with the object event handler from the tree.

The Custom Event Handlers editor opens on the content pane and the drop-down menu in the column that is
associated with the PHP code le is activated.

4. Click the drop-down menu in the applicable column (Create, Update, or Destroy) and select the object event
handler that you want to associate the object with.

5. To allow the object event handler to be suppressed from the SuppressExternalEvents processing option that is
part of  Connect Web Services for SOAP  and the  Connect PHP API , select the check box in the Can Suppress
column.

6. Click Save.

Before you can use the object event handler, the process model must be tested and deployed. See Deploy the Process
Model and Roll Back the Process Model.

Export the Process Model  
You can export process models, for example, from your test site.

Before you deploy a process model on your production site, we recommend that you rst test it on a test site that is
similar to your production site. This helps ensure that the object event handlers function as expected and interact with
the Oracle Service Cloud data in the way you want. After verifying that the process model is congured correctly on the
test site, you can export it from the test site and then import it into your production site.

1. Click Conguration on the navigation pane.
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2. Expand Site Conguration, then double-click Process Designer.
The process designer opens on the content pane.

3. Click Export on the ribbon.
The Export Process Model Wizard opens.

4. Select the check boxes next to the object event handlers that you want to export.
5. To export object event handler mappings, select Export Event Handler Mappings.
6. Click Next.
7. Click the Browse icon to open the Save As window where you can select the location to save the export le,

then enter a name in the File eld.
The export le is saved with a .zip extension.

8. Click Save.
9. Click Next to complete the export.

If successful, a message informs you that the export was successful.
10. Click OK to close the message and the wizard.
11. Click X on the console to close the process designer.

Import the Process Model  
You can import process models, for example, into your production site.

Before you deploy a process model on your production site, we recommend that you rst test it on a test site that is
similar to your production site. This helps ensure that the object event handlers function as expected and interact with
the Oracle Service Cloud data in the way you want. After verifying that the process model is congured correctly on the
test site, you can export it from the test site and then import it into your production site.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Process Designer.

The process designer opens on the content pane.
3. Click Import on the ribbon.

The Import Process Model Wizard opens.

Note:  When exporting and importing the process model, you choose which object event handlers
to include and exclude. Since you cannot save more than fty object event handlers (with unsaved
content) at one time, the maximum number of object event handlers that can be imported at one time
is fty.

4. Click the Browse icon to select the .zip le that contains the process model you want to import.
5. Click Next.

If you import an object event handler with the same name as an existing event handler, you can either replace
(overwrite) the imported event handler or import it as a new event handler with the number “1” appended to its
name.
The next page of the wizard shows you the object event handlers that can be imported.

6. Select the check boxes next to the object event handlers that you want to import.
7. Select options for the imported object event handlers.

a. To create a new object event handler, click the arrow next to the text that reads replace event handler and
select imported as a new event handler.

b. To prevent an object event handler from being imported, clear the check box next to it.
8. To import object event handler mappings, select Import Event Handler Mappings.
9. Click Next to complete the import.
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A message informs you that the import was successful.
10. Click OK to close the message and the wizard.
11. To deploy the imported process model on your site, click Deploy on the ribbon. See Deploy the Process Model.
12. Click X on the console to close the process designer.

Deploy the Process Model  
After you create and test the process model, it must be deployed. When the process model is deployed, all object event
handlers are mapped to custom and standard objects in the database and are ready for execution when an event occurs
in Oracle Service Cloud.

Because of the changes at the database level, it is important that you test the process model before deploying it. See
Best Practices for Testing Object Event Handler Scripts for information about potential issues and best practices when
creating and testing object event handler scripts.
To assist you with testing, export and import functionality is available so you can test the process model on a test site
before deploying it to a production site. See Export the Process Model and Import the Process Model.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Process Designer.

The process designer opens on the content pane.

Note:  Before you deploy the process model, we recommend that you rst review the object event
handlers to conrm that no additional changes are needed.

3. Click Deploy on the ribbon.
The Deploy window opens.

4. Enter the email addresses in the Email Address eld to which you want to send notications.
Addresses entered in this eld receive emails when deployment completes or when an issue preventing
deployment is encountered. The logged-in sta account’s email address is automatically added.

Note:  Multiple addresses must be separated by commas.

5. Click Deploy.
A message informs you that you are about to deploy the server process model, which disables the process
designer until the deployment is complete.

6. Click Yes to close the message and start the deployment.
A message noties you when the deployment is nished and that the process designer will be refreshed.

7. Click OK to close the message and return to the process designer.
8. Click Save.

Roll Back the Process Model  
If you have not yet deployed the process model, you can roll it back to revert to the state it was in at the time of the most
recent deployment.

If the process model has never been deployed, rolling it back removes all object event handlers.
1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Process Designer.
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The process designer opens on the content pane.
3. Click Rollback on the ribbon.

The Rollback window opens and a message informs you that all saved changes made on the process designer
since the last deployment will be removed, and that after a rollback has been performed it cannot be undone.

4. Click OK to close the Rollback window and start the rollback process.
5. Click Save.

View Custom Process Error Logs  
Custom process error monitoring provides a read-only report with information on errors that occur when running
custom processes.

You must add the Process Designer to the navigation sets of all proles that will create and monitor custom processes.
The Error Log buon is on the ribbon of the Process Designer, in the Show group.

You can diagnose custom process errors without having to contact our support sta. Errors are processed
asynchronously at 15-minute intervals by the DQA utility.

1. In the Process Designer, click Error Log.
The CPM Errors report displays.

The error log report shows:

• Operation (such as Create or Update)

• Class (object such as Organization or Contact)

• Object ID

• Error summary

• Error content

• Time of occurrence

• Interface

Custom Process Logging for Debugging Scripts  
The logging framework can be used for debugging runtime problems with custom process scripts during development
and testing.

Two entities are used in custom process logging:

• Terminals—The Terminal class provides the logging function. You dene terminals in PHP scripts that you
import into the Process Designer. The Terminal class is provided with Connect Common Object Model (CCOM)
version 1.3 and later.

• Probes—Probes control which terminals are used for logging. You create probes on the Agent Browser UI using
the Probe Designer.

Note:  The Probe Designer currently works only on the Agent Browser UI. However, you create the custom
process models for logging in the Service Console.
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Probes control which terminals are activated based on these elds:

• Terminal Name

• Log Level

When a probe is enabled, it activates all terminals whose:

• Terminal name matches the name, wildcard, or regular expression provided in the probe. Terminal names are
dened in the custom process model script.

• Log level is as severe as, or more severe than, the log level provided in the probe.

You use these rules for writing regular expressions in the Terminal Name eld:

Expression Indicates

+ One or more of the previous character

* Zero or more of the previous character

. Any character

\w Any word character (alphanumeric or underscore). Only matches standard ASCII characters (no
accented or non-Latin characters).
This expression is equivalent to [A-Z a-z 0-9 _ ].
 

For example:

• ter+ will match ter and terr, but not te or term

• ter* will match te, ter, and terr, but not term

• term.* will match term, term1, and termm

Probes have these log levels, which are listed in order of decreasing severity:

ID Name

1 FATAL

2 ALERT

3 CRITICAL

4 ERROR

5 WARN

6 TRACE

7 INFO

8 DBG

You must perform these tasks to implement custom process logging:

1. Enable Custom Process Logging.
2. Dene the Terminals in the Custom Process Script.
3. Create the Object Event Handler.
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4. Create Probes for Logging.
After creating the probes, you perform operations to test your custom processes, then examine the custom process logs.

Enable Custom Process Logging  
You must have custom process logging enabled to use it.

1. Conrm that the ENABLE_CPM_LOGGING conguration seing is enabled. This seing is not enabled by
default. To enable this hidden seing, contact your Oracle account manager or submit a service request on our 
support site.

Dene the Terminals in the Custom Process Script  
You dene terminals for custom process logging in PHP scripts that you import into the Process Designer.

Custom process logging uses this PHP syntax:

use \RightNow\Connect\v1_3 as versioned_namespace;
versioned_namespace\Terminal::logger(terminal_name, log_level, log_message);

For example:

use \RightNow\Connect\v1_3 as RNCPHPV3;
RNCPHPV3\Terminal::logger(terminal1, 'Fatal', 'This is a fatal error.');

1. Create a PHP le, like you would for any custom process script, that denes the terminals you wish to use for
logging.

The following example shows a PHP script for logging events associated with custom processes for Organization
objects.

<?

/**
 * CPMObjectEventHandler: OrgTest
 * Package: RN
 * Objects: Organization
 * Actions: Create, Update, Destroy
 * Version: 1.2
 **/

/**
define("Fatal","1");
define("Alert","2");
define("Critical","3");
define("Error","4");
define("Warning","5");
define("Trace","6");
define("Info","7");
define("Debug","8");
**/

// This object procedure binds to v1_2 of Connect PHP.
use \RightNow\Connect\v1_2 as RNCPHP;

// This object procedure binds to the v1 interface of SPM.
use \RightNow\CPM\v1 as RNCPM;
use \RightNow\Connect\v1_3 as RNCPHPV3;

class OrgTest implements RNCPM\ObjectEventHandler
 {
 public static function apply( $run_mode, $action, $obj, $n_cycles )
 {
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 $terminalObj = new RNCPHPV3\Terminal;
 $terminalObj::logger("terminal1", 1, "This is a fatal error.");
 $terminalObj::logger("terminal1", 'Fatal', "This is a fatal error.");
 $terminalObj::logger("terminal1", 'Debug', "This is a debug message.");
 $terminalObj::logger("terminal1", 'Info', "This is an info message.");
 $terminalObj::logger("terminal2", 'Critical', "This is a critical error.");
 $terminalObj::logger("terminal2", 'Info', "This is an info message.");
 $terminalObj::logger("terminal3", 'Alert', "This is an alert.");
 $terminalObj::logger("terminal4", 4, "This is an error.");
 $terminalObj::logger("terminal6", 'Debug', "This is a debug message.");
 $terminalObj::logger("terminal6", 'Warning',"This is a warning.");

 // For testing

 if (is_null($obj->Notes))
 {
 $obj->Notes = new RNCPHP\NoteArray;
 }
 $note = new RNCPHP\Note;
 $note->Text = date( 'r' ) . "\n";

 switch ( $action )
 {
 case RNCPM\ActionCreate:
 $note->Text .= "Created";
 break;

 case RNCPM\ActionUpdate:
 $note->Text .= "Updated";
 break;

 case RNCPM\ActionDestroy:
 $note->Text .= "Destroyed";
 break;

 default:
 assert( !'
 !!! Unknown action !!!
 ' ) || die( -1 );
 }
 
 $note->Text .= " by " . __CLASS__ . "\n";
 $obj->Notes[] = $note;

 if (RNCPM\RunModeLive != $run_mode)
 {
 echo( "\nHello from OrgTest, run_mode= $run_mode, action= $action, id= {$obj->ID} n_cycles= $n_cycles
\n" ); // */
 echo( "Note= " . $note->Text );
 return;
 }

 // End testing
 
 return;
 }
}

class OrgTest_TestHarness implements RNCPM\ObjectEventHandler_TestHarness
{
 public static function setup()
 {
 // Nothing special to set up.
 return;
 }
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 public static function fetchObject( $action, $object_type )
 {
 $org = new RNCPHP\Organization;
 switch ( $action )
 {
 case RNCPM\ActionCreate:
 $org->Name = 'A new Org';
 break;

 case RNCPM\ActionUpdate:
 $org->Name = 'An updated Org';
 break;

 case RNCPM\ActionDestroy:
 $org->Name = 'A destroyed Org';
 break;
 }

 $org->save();
 return( $org );
 }

 public static function validate( $action, $object )
 {
 assert("
 1 === ".count( $object->Notes )."
 " ) || die(-1);
 return( true ); // It's false.
 }

 public static function cleanup()
 {
 // Nothing special to clean up.
 return;
 }
}

Create the Object Event Handler  
You create the object event handler from the custom process logging PHP script. Then you associate the event handler
with an object.

You must perform these tasks before creating object event handlers:

• Add the Process Designer to the navigation sets of all proles that will create custom processes.

• Dene the Terminals in the Custom Process Script in the custom process PHP scripts.

See Object Event Handlers for more information on creating object event handlers. See Associate an Event Handler with
an Object for more information on associating event handlers with objects.

1. In the Process Designer, create an object event handler from your PHP script that dened the terminals.
2. Save and test the object event handler.
3. Associate the object event handler with the object for which the PHP script was wrien.

In our example, the event handler is for Organization objects.
4. Save and deploy the custom process model.

Create Probes for Logging  
You create probes for logging custom processes by using the Probe Designer on the Agent Browser UI.
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You must add the Probe Designer to the navigation sets for proles that need to use it. The Probe Designer is found in 
Components > Common  in the Navigation Sets editor on the Service Console.

The Probe Designer currently can be used only in the Agent Browser UI.
1. In the Agent Browser UI, click the Navigation Menu icon, then navigate to Probes.

The Probe Designer opens in the Probes report.
2. Click New on the toolbar.

The Probe workspace opens.
3. In the Name eld, enter a name for the probe.
4. In the Terminal Name eld, enter a terminal that is dened in your PHP script for custom process logging.

You can also use wildcards and regular expressions.
5. From the Log Level drop-down menu, select a logging level that is dened for the terminal.

Every terminal with that log level and higher (greater severity) will be logged.
6. Select the Enable check box to enable the probe.

Note:  The maximum number of enabled probes is 50.

7. Click Save & Close to save the probe and return to the Probe Designer.
8. Click Refresh on the toolbar to see the new probe.

If you have many probes, you can use the Filters option to limit the number of probes displayed per page. The
maximum number is 10000.

In our example, we created an event handler for Organization objects, so you can test the probe by creating and
updating organizations.

Examine the Probe Logs  
After creating the probes, you test them, and then examine the probe logs.

1. In the Probe Designer, click Log in the row for the probe whose log you wish to examine.
The CPM Logs report displays. The notications for each logged event are grouped as a run. The run number is
a unique number generated to group the logs generated in a single execution of the custom process model.

2. Use the Filters option to search by time, log level, and probe ID.
The maximum number of records that can be displayed is 10000.

Asset Management  

Overview of Asset and Product Registration  
Knowing which products and services your customers are using helps you respond to their needs. For instance, an
organization selling mobile phones can more quickly assist a customer if they know which model the customer owns.
Organizations can also proactively contact customers with information pertaining to the products they own.

Using Oracle Service Cloud, you can congure the assets you want to associate with your customers. These assets can
require serial numbers or not, depending on your needs, and can be registered by customers on the customer portal or
by agents on the agent desktop.
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Note:  An assets solution can be created using custom objects or an integration. However, using the asset
and product registration tool makes it easy to quickly implement an assets solution and adopt future
enhancements.

Asset Planning  
There are a number of ways you can use assets. Some organizations will want to track assets without serial numbers,
others will want to track serialized assets, and others will use external applications to validate serial numbers.

The steps you use to manage assets vary depending on your organization’s needs. Consider these general use cases
before you congure your asset management system.

• You want to track assets that do not use serial numbers—In this instance, you need to create asset products,
but you do not need to create individual asset records since they can be created when customers or agents
register an asset with a contact or organization. When creating products in the product catalog for non-
serialized asset products, you will not select the Serialized check box. See Add or Edit a Sales Product to Use
with Assets.

• You want to track assets with unique serial numbers and want to validate the serial numbers using Oracle
Service Cloud—In this instance, you need to create asset products, and then add an asset record for every
unique serial number. After the asset records are created, customers can register their product on the customer
portal by entering their product’s serial number. The system then associates the contact or organization with
the asset record that has the serial number the customer entered.

When creating asset records in advance of product registration, the records should have a serial number, a status of
Unregistered, and not be associated with a contact or organization.

• You want to track assets with unique serial numbers and you have an external serial number validation
system—In this instance, you need to create asset products (see Add an Asset Record), but you do not need
to create asset records. However, you need to use a customized customer portal widget that accesses your
validation system. When a customer enters a serial number, the custom widget sends the information to the
external system to validate. If the serial number is validated, the custom widget then creates an asset record,
populates it with the correct information, and creates the association between the contact or organization
record. Contact your Oracle account manager for information about custom widgets.

• You want to track assets with unique serial numbers but do not need to validate the serial numbers—In this
instance, you need to create asset products, but not individual asset records. Using a custom widget, customers
enter serial numbers for their products on the customer portal, but the serial numbers are not veried. The
custom widget then creates asset records and populates them with the serial numbers your customers provide
along with other pertinent information.

Regardless of how you manage assets, standard reports make it easy to view information related to them. These reports
are available in the Reports explorer’s Public Reports/Service/Assets folder. You can also create custom reports if the
standard reports do not meet your needs.

How You Set Up Assets  
Before your agents and customers can manage assets, you must congure the items you want to track.

• Congure asset statuses to help you track asset usage if the three default statuses (Active, Retired, and
Unregistered) do not meet your needs. See Add or Edit an Asset Status.
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• Create the products or services you want to track in the product catalog and specify if they should have serial
numbers. See Add or Edit a Sales Product to Use with Assets.

• Congure your workspaces and assign them to the appropriate proles. You can create custom asset
workspaces or use the default workspaces. You can also create custom incident, contact, and organization
workspaces to add asset elds and relationship items. See Asset Workspaces.

• Congure navigation sets to let agents easily create assets and view asset reports. See Assets and Navigation
Sets.

• If you want to use serialized products and perform serial-number validation in Oracle Service Cloud, create
asset records and associate them with your customers. If you have an existing database where you store assets,
you can import the data into Oracle Service Cloud using the Data Import Wizard. See Asset Planning and Add
an Asset Record.

• If you want your customers to be able to view and register their products on the customer portal, add the
appropriate widgets to the customer portal pages. See Product Registration on the Customer Portal.

• Assets are similar to the other standard objects in Oracle Service Cloud such as incidents, contacts, and
answers. Just as with these objects, you can add system aributes to the asset object if you require additional
elds to meet your needs. See Create a System Aribute.

Add or Edit an Asset Status  
Asset statuses help you manage assets by tracking which assets are in use, which are no longer used or supported, and
which assets have not been associated with customers.

The three default statuses are Active, Retired, and Unregistered, and are associated with three status types, also named
Active, Retired, and Unregistered. These status types have dierent purposes.

• Active—This is used for assets that are associated with contacts or organizations.

• Retired—This is used for assets that have previously been associated with contacts or organizations, but are no
longer in use. Instead of deleting these records, you can use the Retired status type to continue to track assets
that are no longer used.

• Unregistered—This is used for assets that have not been associated with contacts or organizations.

You can rename the three default statuses and add additional statuses to help you beer organize assets. When you
add a status, you must assign it to one of the three status types. You cannot modify the asset status types or add
custom status types.

1. Double-click Customizable Menus in  Conguration > Application Appearance .
2. Expand the System Menus folder.
3. Click Asset Statuses to display the editor.
4. To edit an existing status, click the status.
5. To add a new status, click New.
6. Click Status and select a status type.

After you save a status, you cannot change its status type.
7. Enter a name for a new status or edit an existing one in the Label eld.
8. Click Save.

Add or Edit a Sales Product to Use with Assets  
To congure assets, you must add sales products you want to associate with contacts and organizations.

These can be any unique item or resource you want to track. You add these items using the product catalog. However, if
you have an existing asset management system, you can bulk import asset products using the Data Import Wizard. See
Import Asset Records.

248



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

If you currently use sales products with quotes and Oer Advisor promotions and suggestions, you can also use them
for asset management and product registration. See Add or Edit a Sales Product.

Note:  If you delete an asset product, all asset records congured to use the product will also be deleted.

1. Double-click Product Catalog in  Conguration > Opportunity Tracking .
2. Do one of the following:

◦ Click New to add a new product.

◦ Click an existing product to edit it.

3. Enter the name in the Product Name eld.
4. To add an additional identier for the product, enter it in the ID eld.
5. To prevent the product from being used by agents or displaying in editors, select Disabled.
6. To make the asset available for use in opportunity tracking, select Sales Catalog.

This is not necessary when conguring products for use in asset management.
7. To make the asset available for use in Oracle RightNow Cloud Service (Service), select Service Catalog.

This option must be selected to create asset records using the product, and to associate it with contacts and
organizations.

8. To prompt customers and agents to enter a serial number for an asset related to the product, select Serialized.
It is important to consider your organization’s requirements before selecting this option. See Asset Planning.

9. To associate a service product with the asset product, select it from the Service Product drop-down menu.
Any incidents created from the Service Console or customer portal that apply to the asset will automatically be
populated with the selected service product.

10. Click Save.

Asset Workspaces  
Agents use asset workspaces to create, edit, and view assets. Incident, contact, and organization workspaces can also be
modied to include asset information.

Standard asset and asset multi-edit workspaces are available for adding and editing assets. These standard workspaces
are automatically added to proles when assets are enabled. You can use these standard workspaces or create custom
workspaces. Creating custom workspaces for assets is no dierent than creating workspaces for other standard objects.
See Overview of Workspaces.

Note:  If you want to use custom asset workspaces, you must select them on the Proles editor’s Interfaces
page. See Custom Workspaces.

You should also review your incident, contact, and organization workspaces to ensure they include the asset elds and
relationship item that agents need to work with assets that are associated with these record types.

• Asset elds—You can add elds from the assets table to incident workspaces. This gives your agents the ability
to view or modify asset information when they work with an incident that is associated with an asset record.
These elds include information such as the asset’s name, price, and serial number.

• Assets relationship item—You can add the Assets relationship item to contact and organization workspaces.
This is needed for agents to view the assets associated with contact and organization records. Using the
relationship item, agents can delete existing asset relationships, or open the assets editor to add asset records
to a contact or organization.
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Assign Asset Prole Permissions  
Prole permissions must be specied for those sta members who require access to assets. These permissions allow
sta members to view, add, edit, and delete assets.

1. Double-click Proles in  Conguration > Sta Management .
2. Double-click the prole you want to assign permissions to.
3. Select  Permissions.
4. Click the Service tab.
5. Select the appropriate check boxes under the Asset heading.
6. To assign all asset permissions to the prole, select Select All.
7. Click Save.

Assets and Navigation Sets  
You can modify navigation sets to let agents work with assets on the Service Console and the Agent Browser UI.

You must add the Assets navigation buon to the navigation sets used by your agents so they can access asset records.
You can also add the New Asset item to the le menu so agents can quickly add assets. In addition, you can add asset
reports, located under \Public Reports\Service\Assets, to the Asset navigation buon, or any other navigation
buon. See Overview of Navigation Sets.

Add an Asset Record  
After conguring assets, your agents can add and manage assets on the Service Console.

Assets can also be bulk imported from a le using the Data Import Wizard (see Import Asset Records). Assets can be
added on the assets editor, and when viewing contact and organization records.

1. Do one of the following:

◦ If you are viewing a record in the assets editor, click New.

◦ If your navigation set is congured to add assets from the le menu, click  File > Asset . See Congure the
File Menu.

◦ If your contact or organization workspace includes the assets relationship item, view the asset list in the
contact or organization record, click  Add > Add New .

2. Enter eld information.

Field Description

*Name
 

Enter a name for the asset record in this eld.
 

*Product
 

Click this drop-down menu and select the asset product. See Add or Edit a Sales Product
to Use with Assets.
 

Serial Number
 

If using serialized assets, enter the asset’s serial number in this eld. See Asset Planning.
 

Contact/Organization
 

Click the buons next to these elds to select the contact or organization you want to
associate with the asset. These elds are populated when creating an asset from the
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Field Description

contact or organization record. When creating asset records for future registration, the
elds may be left empty. See Asset Planning.
 

Price
 

Enter a price for the asset in this eld. Click the currency shown to select a dierent
currency, and click the buon to view exchange rates. See Add or Edit a Currency.
 

*Date Purchased
 

Enter the date the asset was purchased or obtained, or click the calendar next to the
eld to select a date.
 

Date Installed
 

Enter the date the asset was installed or activated, or click the calendar next to the eld
to select a date.
 

Date Retired
 

Enter the date the asset was retired or deactivated, or click the calendar next to the eld
to select a date.
 

Status
 

Click this drop-down menu and select a status for the asset. See Add or Edit an Asset
Status.
 

Description
 

Enter a description or notes for the asset in this eld.
 

3. To associate the asset with a new incident, click the Incidents tab.
a. Click Add New and complete the elds. See Edit Key Incident Fields.

4. To view the audit log for the asset record, click the Audit Log tab. See Audit Logs.
5. If you are adding the asset from the contact or organization record, click OK.
6. Click Save.

Import Asset Records  
If you have an existing database where you store assets, you can import asset records instead of creating them
manually.

You can also import information that associates assets with your customers.

You import this information into Oracle Service Cloud using the Data Import Wizard. The le that contains the data you
want to import can include the following information. See How Data Import Works.

• Name—This is the name of the asset product. This eld is required.

• Product ID—This maps to the product_catalog.product_id eld. This eld is required.

• Serial number

• Asset status

• Organization ID—This maps to the orgs.org_id eld. This lets you associate the asset with an existing
organization.
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• Contact ID—This maps to the contacts.c_id eld. This lets you associate the asset with an existing contact.

• Purchase date

• Install date

• Retire date

• Description

Related Topics
• Add or Edit a Sales Product to Use with Assets

Product Registration on the Customer Portal  
The objects that are called assets on the Service Console are called registered products on the Customer Portal.

When you have created assets on the Service Console and congured product registration for your customer portal,
your customers can register their products themselves.

Add Product Registration Files to Your Customer Portal  
The widgets necessary for product registration are included in the standard widgets on the reference implementation.
The page les, however, are not provided as part of the reference implementation.

The procedure for adding product registration les instructs you to overwrite several of the reference implementation
pages. If you have customized these les, best practice suggests making a copy of these les and then customizing the
new les with the same changes that you made to the original reference implementation pages. Having backup les
also lets you revert from the new functionality to your previous implementation if necessary.

1. Download the product_registration.zip le.
2. Unzip the les to your workstation.
3. Copy the unzipped les to the appropriate customer portal le.

Downloaded Files Customer Portal Location

Asset32.png /cp/customer/assets/themes/standard/images/icons

standard.php /cp/customer/development/views/templates

ask.php /cp/customer/development/views/pages

detail.php /cp/customer/development/views/pages/account/questions

overview.php /cp/customer/development/views/pages/account

4. Copy the assets folder from the unzipped les to /cp/customer/development/views/pages/account.
The folder should contain the following les.

◦ asset_registration_conrmation.php

◦ detail.php

◦ list.php
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◦ register_asset.php

◦ serialnumber_validate.php

◦ update_registered_product.php
5. Modify the site.css le in /cp/customer/assets/themes/standard by following these steps.

a. Open the downloaded site.css le in a text editor and copy all content.
b. Open the /cp/customer/assets/themes/standard/site.css le in a text editor.
c. Paste the copied content from the downloaded le to the end of the /cp/customer/assets/themes/

standard/site.css le.
d. Save site.css.

CAUTION:  You are going to add content to the existing site.css le. Do not replace /cp/customer/
assets/themes/standard/site.css with the downloaded site.css le.

6. To let your customers view products that are registered to other members of their organization, set a non-zero
value for the MYQ_VIEW_ORG_ASSETS conguration seing.

a. Log in to Oracle Service Cloud.
b. Double-click Conguration Seings in  Site Conguration > Conguration .
c. Enter MYQ_VIEW_ORG_ASSETS in the Key eld and click Search.
d. In the row for MYQ_VIEW_ORG_ASSETS, click the Value column.
e. Enter 1 if you want customers to be able to see products from others in their organization, or type 2 if you

want them to see products from others in their organization and all its subsidiaries.
f. Click Save.

Overview of Product Registration Widgets  
Various Customer Portal widgets support the product registration feature.

• AssetCheck—The AssetCheck widget, located in the core/widget/standard/input folder, directs customers
to the Product Registration page. If the product requires a serial number, the widget also validates that number.
This widget contains the ProductCatalogInput widget, which is also new, and is used on the custom Register a
Product > Product Validation page (assets/serialnumber_validate).

• ProductCatalogInput—The ProductCatalogInput widget, located in the input folder, displays a drop-down
menu for collecting hierarchical tree data for products. It is used to submit product values for registered
products. This widget contains the ProductCatalogDisplay widget and is contained in the AssetCheck widget.

• ProductCatalogDisplay—The ProductCatalogDisplay widget is located in the output folder. It displays the value
of the specied product catalog eld. The system elds that can be displayed are listed on the Business Objects
page of the Customer Portal Administration site, as shown in the following gure. This widget is contained in
the ProductCatalogInput and DataDisplay widgets.

Note:  The business objects for assets can be used only on pages where assets can be created, updated, or
viewed. They are not supported on the Ask a Question page.

• AssetOrgList—The AssetOrgList widget, located in the search folder, displays a drop-down menu that allows
customers to search for registered products associated with their own record or for products associated with
other contacts in their organization or its subsidiaries. The MYQ_VIEW_ORG_ASSETS conguration seing
must be set to a value equal to or higher than the display_type aribute of the widget, which has a default value
of 2.

• ProductCatalogSearchFilter—The ProductCatalogSearchFilter widget, located in the search folder, displays
a drop-down menu containing a hierarchical tree for the product catalog. This widget is contained in the
AdvancedSearchDialog widget.
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How to View Registered Products on the Customer Portal  
When you added product registration les, a modied template le (standard.php) was included. The modied template
contains an option on the Your Account drop-down menu for Registered Products.

The product registration les also include an updated Account Overview page with a new Registered Products section.

Note:  If you migrated your Customer Portal to the current version from an earlier framework version and
implemented product registration before deciding you want to revert to the earlier version, the Registered
Products section remains on the Account Overview page and will display all registered products available on
the site. To prevent this from occurring, edit the reverted overview.php le to remove the RegisteredProducts
div class section.

When logged-in customers select the Registered Products option on the Your Account tab or click the See All Registered
Products link on the Account Overview page, a list of products registered to the customer opens. This page is generated
by the /account/assets/list.php le.

Your customers can search their registered products on this page by any combination of product, status, and keyword.

Clicking a registered product opens the Registered Product details page. This page displays information about the
product as well as any associated incidents. It also includes links that let customers edit the product or go to the Ask a
Question page.

Clicking the Edit Registered Product link opens the Update Registered Product page, where your customers can edit the
product name and status and add or edit the installed and retired dates. See Registered Product Update.

Related Topics
• Add Product Registration Files to Your Customer Portal

View Registered Products from Other Sta Members in an Organization  
By default, customers can see only their own registered products on the Registered Products List page.

If you want to let customers view other products associated with members of their organization, you need to edit a
conguration seing and place the AssetOrgList widget on the page.

1. Enable the MYQ_VIEW_ORG_ASSETS conguration seing as described in Add Product Registration Files to
Your Customer Portal.

2. Open /cp/customer/development/views/pages/account/assets/list.php.
3. Locate the following line of code.

 <div id="rn_PageContent" class="rn_QuestionList">

4. Enter the following code just above the line you located in step 3.
 <rn:widget path="search/AssetOrgList" search_on_select="true" />

Note:  When the search_on_select aribute is true, customers do not have to click the Search buon
after making their menu selection for displaying registered products because the report refreshes
automatically.

5. Save list.php.
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Overview of Registering a Product  
Your logged-in customers can open the page to register a product from the Account Overview page or the Registered
Products list page.

On the Account Overview page, they can click the Register a New Product link in the Registered Products section.

Alternately, if they select the Registered Products option on the Your Account tab drop-down menu, the page displays a
list of registered products and a link to register a new product.

Clicking either of these Register a New Product links opens the rst page in the product registration sequence to
validate the product.

Customers select a product from the drop-down menu, which displays all items created in the Product Catalog on the
Service Console that have the Service Catalog check box selected.

If the product does not have the Serialized check box selected in the Product Catalog, the screen provides a message to
the customer that a serial number is not required. Having selected a valid product, the customer can then click Continue
to register the product.

If, however, the product requires a serial number because the Serialized check box is selected in the Product Catalog on
the Service Console, the message states that the serial number is required.

• The serial number for a serialized product does not match a serial number that was entered on the Service
Console for the product.

• The serial number has already been registered to another customer.

• The product’s status on the Service Console is not Unregistered.

After clicking Continue, the Product Registration step is displayed. The product and serial number are now read-only,
and the customer can complete some of the remaining elds, including name (which is populated with the name it was
given on the administration interface), status, date purchased (also populated with the date from the administration
interface), date installed, date retired, and description.

Note:  If the product does not require a serial number, the act of registration creates and activates a new asset
record. Therefore, the Status selection defaults to Active, and the Name and Date Purchased elds are blank.If
the product requires a serial number, it must match an existing asset record that was created on the Service
Console. When it was created, the asset was set to the Unregistered status and the Name and Purchase Date
were entered. Therefore, when the customer registers the product, the Name and Purchase Date elds are
populated. However, because the customer should not be registering a product with an Unregistered status,
the Status is not set and the Unregistered status is not available.

Registered Product Update  
When logged-in customers select the Registered Products option on the Your Account tab or click the See All Registered
Products link on the Account Overview page, a list of products registered to the customer opens. Then clicking a
registered product opens the Registered Product Details page.

If customers click the Edit Registered Product link on the page, the Update Registered Product page opens.

The product and serial number are read-only, but customers can change the following elds on the page:

• Date Purchased

• Name

• Status
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• Date Installed

• Date Retired

• Description

Clicking the Continue buon opens the Account Overview page, where the Registered Products section contains the
edited product.

Site Conguration  

Overview of Site Conguration  
You can customize conguration seings, either individually or across multiple interfaces, to enable, disable, and
congure Oracle Service Cloud functions. You can also change certain text used in Oracle Service Cloud by customizing
message bases, which are text strings that appear on the administration interface and the customer portal.

The Conguration Seings and Message Bases editors display as their own respective reports with category folders
and runtime selectable lters that make searching easy. You can control how your output displays using either cross
tab (default) or rollup views and edit values for conguration seings and message bases text inline. You can also see
any changes that have been made to your conguration seings and message bases, including the old and new values,
from the audit log.

Other site conguration options include the File Manager that you can use to change wordlist and dictionary les, and
the Log Viewer, which can help you troubleshoot issues your site may have.

For information about conguring customer portal pages and working with the customer portal, see Conguring Oracle
Service Cloud for Customer Portal.

Related Topics
• How the Conguration Seings Editor Works

• How You Customize Conguration Seings

• How the Message Bases Editor Works

• How You Customize Message Bases

• Service Update Notications

• Search for a Conguration Seing

• Search for a Message Base

• Edit a Conguration Seing

• Edit Message Base Text

Search for a Conguration Seing  
Runtime selectable lters let you dene which conguration seings display on the content pane. You can search by site
or interface, conguration seing type, category folder, conguration seing name, and value.
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The rst time you open the Conguration Seings editor, you must perform a search. Because seings are categorized
as either site or interface specic, the conguration seings Search window lets you specify what type of seing you
want to see.

Note:  Depending on your site’s conguration, some seings may be hidden. If you cannot nd a certain
conguration seing, contact your Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens. (The Conguration Seings editor also opens but is inactive at this point.)
You have several options on the Search window. You can:

◦ Use the search elds to lter the conguration seings that are returned on the editor.

◦ Accept all default lters by simply clicking Search to return every interface-specic conguration seing
on the site you are logged in to.

◦ Click Cancel to bypass the window and search using the buons on the ribbon or the search elds on the
top of the editor.

◦ Customize the lters and save them as your defaults by selecting Save as Default Values from the
Seings drop-down menu before clicking Search. The next time you access conguration seings from
your conguration list, the Search window does not open because the system remembers your defaults.
Instead, the Conguration Seings editor opens with your previously ltered search results.

◦ Design the layout of your Search window by selecting Enter Search Design Mode from the Seings drop-
down menu.

As you congure your application, you will likely use a combination of these options depending on the
conguration seings you want to access. However, for the purpose of this procedure, we show you how to
customize your search results using the lters on the Search window.

3. Select the lters, sort options, and record limit to be displayed on the editor.

Tip:  If you use the search default seings, every interface-specic conguration seing on the site
you are logged in to will be returned. If you have a large site, you may want to consider narrowing
your search to return only the seings you need to see. One way to do this is to lter the seings by
category folder. If you know the main folder in which the seings you want to see are located, select
only that folder from the Folders eld.

Field Description

Filters This section displays the runtime selectable lters. If a lter displays a menu list, you
can select all options in the list by selecting the Select All check box, or you can clear all
options in the list by clearing the Select All check box.

Conguration Base Select the check boxes next to the interfaces for which you want to display conguration
seings.
Select All—Displays all site- and interface-specic seings.
 
Logged In—Displays only interface-specic seings for the interface you are logged in
to. (Default)
 
Site—Displays only site-specic seings that are shared across all interfaces on this site.
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Field Description

<interface name>—Displays only interface-specic seings that apply to the selected
interface.
 

Type Select the check boxes next to the type of conguration seing you want to display.
Select All—Displays all site- and interface-specic seings. (Default)
 
Site—Displays only site-specic seings that are shared across all interfaces on this site.
 
Interface—Displays only those seings that are specic to the interface you are logged
in to.
 

Folders Select the folders that contain the conguration seings you want to display.

Key Enter the name of a specic conguration seing in this eld. This eld is not case
sensitive.
You can also enter just the rst few leers and append either the percentage sign (%) or
an asterisk (*) to serve as a wildcard. All seings that begin with the leers you type will
be returned.
 

Default Value Enter a default value to return seings that match the value you type.

Value Enter a value to return seings that match the value you type.

Limit and Order Use options in this section to limit the number of rows returned and how the output
should be sorted.

Limit To Select this check box to limit the number of rows returned on each page. Limiting the
records returned prevents more records being returned than can be easily viewed or
printed.

Rows Enter the number of rows to be returned.

Per Page Select this check box to change the number entered in the Rows text box from a hard
limit on the total number of rows returned to a limit on the number of rows returned on
each page. This is automatically selected when you select Limit To.

Order By Click the current sort order next to the Order By eld to select dierent sort options.
The default sort order is displayed with the primary sort eld listed rst, followed by any
subsequent sort elds. The direction each sort eld is ordered in is also indicated (Asc
for ascending order and Desc for descending order). See Change Sort Order Using the
Ribbon and Change Sort Order Using Column Headers.

Seings This drop-down menu gives you options to design and then save your Search window
layout. It also lets you set, restore, and reset your default lter values.

Enter Search Design Mode Select this option to design the layout of your Search window. See Overview of the
Search Window.

Set as Default Layout Select this option to save your search layout as the default.
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Field Description

Restore Default Layout Select this option to reset your search layout to the system default.

Save as Default Values Select this option to save the lter values you select to the local seings on your
workstation. These saved values are used as the defaults the next time you search
and are logged in with the same sta account. Saving your search lters bypasses the
Search window and automatically opens the Conguration Seings editor to display
your previously ltered search results.
The default values are overwrien if you select dierent values and click this buon
again. If the search criteria is later edited to change lters, the default lter values stored
in your local seings are ignored.
 

Restore Default Values Select this option to restore the search values to the default search values. This deletes
saved search values from your local seings.
This buon is disabled if the current search parameters were not populated from your
local seings. See Change Your Personal Seings.
 

Reset Values Select this option to reset the search parameter values to the default values that were
populated when the editor opened. Clicking this buon also resets the Conguration
Seings window to the default size if it has been resized.

4. Click Search.

Your search criteria displays on the content pane.

How the Conguration Seings Editor Works  
After performing a search, the Conguration Seings editor displays your search results on the content pane.

Reports drive the data that displays, and you can choose either cross tab or rollup mode for the layout view. In rollup
view, if you have more than one interface, you can edit a conguration seing for multiple interfaces at one time. (Cross
tab is the default.)

This image shows the Conguration Seings editor displaying search results in cross tab mode.
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Most of the buons on the Conguration Seings editor ribbon reect common Oracle Service Cloud functionality
and work the same way as they do in reports. For information about working with reports in Oracle Service Cloud, see
Overview of Managing Reports on the Reports Explorer.

Conguration Seings Editor Home Tab  
From the Home tab on the ribbon, you can create and edit conguration seings, search and lter the data, dene how
you want the data to display, and export the data in a variety of formats. You can also edit values inline under the value
columns.

Group/Buon Description

Record The buons in this group let you open existing conguration seings and create and delete custom
seings.

Open Click this buon to open the selected conguration seing.

Delete Click this buon to delete a custom conguration seing.
Standard conguration seings cannot be deleted. Therefore, this buon is available only for custom
seings.
 

New Click this drop-down menu to create a custom conguration seing. Data type options include Text,
Integer, Menu, Yes/No, and Date/Time.
You cannot change the data type after you have selected it.
 

Editing The buons in this group let you edit conguration seing values.

Save Click this buon to save your changes.

Edit Selection Click this buon to open either the Site or <interface name> window and enter the value of the
selected conguration seing.
In the default cross-tab view, you can edit only one row at a time. Therefore, if more than one row is
selected, this buon is disabled.
 

Auto Save Click this buon to automatically save your inline edits.
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Group/Buon Description

Auto Save works only for inline edits. The Save buon is disabled when Auto Save is selected. See Edit
an Individual Value Inline and Edit Values in Multiple Rows Using the Ribbon.
 

Restore Click this buon to return the selected conguration seing to its default value.

Data Set The buons in this group let you search for conguration seings, refresh the display, and reset the
search criteria to the defaults.

Search Click this buon to open the Search window and select criteria for runtime selectable lters. See Search
for a Conguration Seing.

Refresh Click this buon to reload the data shown using the current search criteria.

Note:  This buon works dierently when you edit a conguration seing. If you change a
value before saving, clicking the Refresh buon reverts to the previously saved value.

Reset Click this buon to reload the data shown using the default search criteria.

Find Click this buon to locate text, numeric values, or special characters on the current page. Cells that
contain the search value are highlighted. See Find Content in a Report.
The Find buon works only on the currently displayed page.
 

Find Next Click this buon to highlight the next instance of the search value entered on the Find window.

Clear Click this buon to clear the search value entered on the Find window.

View The buons in this group let you dene display options, view changes that have been made, and
manage failed deployments.

Cross Tab Click this buon to display conguration seings in a table format. This is the default view.

Rollup Click this buon to display conguration seings in rollup levels. The data rolls up by conguration
seing name. If you have more than one interface, this view lets you edit multiple rows at the same
time for the same conguration seing. See Dene Rollups and Edit the Same Conguration Seings
Across Multiple Interfaces.

Audit Log Click this buon to view changes that have been made to the conguration seings, including when
the change was made, who made the change, the aected conguration base, conguration seing
name, and old and new values. You can also use runtime selectable lters to search for specic
conguration seings.

Meta Data Click this buon to select criteria to display the aributes associated with conguration seings. See
Export Conguration Seing Metadata.

Pending Changes Click this buon to open the Pending Changes window and view changes that failed to deploy during
the save process. You can deploy all changes from this window.
Nothing displays unless there is a failed deployment.
 

Analyze The buons in this group let you sort the displayed data and apply auto ltering, rollups, and slicing to
the data.

Auto Filter Click this buon to enable auto-ltering. Auto-ltering provides column ltering after the report has
been generated. See Enable Auto Filters.

Sort Click this buon to open the Sort window and select which output columns to sort by and the sort
method. See Change Sort Order Using the Ribbon and Change Sort Order Using Column Headers.
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Group/Buon Description

Report The buons in this group let you export the data, forward the data in an email, and save and restore
default values.
Permission to export, print, and forward reports must be enabled in your prole for this buon to
display. See Analytics Permissions.
 

Export Click this buon to export the data from a le for use with third-party applications. You can export data
in the following formats: HTML, PDF, Excel, XML, Image, and Delimited. You can also copy data to the
clipboard. See Export Report and Dashboard Data.

Forward Click this buon to send the data to individuals or distribution lists in an email. See Forward a Report.

Print Click the arrow on this buon to access printing options.

Conguration Seings Editor Page Setup Tab  
The Page Setup tab lets you congure printing options. You can also change the background, margins, and width of
reports.

Each tab has one or more groups containing buons you can use to modify printing or display options. Some groups
have an arrow to the right of the group name that you can click to open a window. For example, you can click the arrow
on the Background group to open the Display Options window.

Windows give you access to the same features you can access from the ribbon, although the windows group the options
dierently, and sometimes contain options not available from the ribbon.

Group/Buon Description

Print The buons in this group let you congure printing options and add the Page Header and Page Footer
sections. Click the arrow on the Print group to open the Page Setup window. See Print a Report.
This buon group displays only if your prole includes the Print/Export/Forward Reports permission.
See Analytics Permissions.
 

Print Margin Click this buon to select the size of the margins used when printing. The available options are Normal,
 Narrow, Medium, and Wide.

Size Click this buon to select the paper size. The available options are Leer, Legal, Executive, A3, A4, and
A5.

Portrait/Landscape Click these buons to print in portrait or landscape mode.

Page Header/Page Footer Select these check boxes to include a page header and page footer when printing the report.

Print to Fit Select this check box to scale your output to your printer default page width and send it to the printer.

Background The buons in this group let you add a background color. You can add a gradient color to blend into
the primary color and choose how intense the colors should be with the Transparency seing. Click the
arrow on the Background group to open the Display window.

Fill Color Click this drop-down menu to select a background color.

Gradient Click this drop-down menu to apply a gradient to the background.
This option is available only after you have selected a ll color.
 

Transparency Click this drop-down menu to apply a transparency to the background.
This option is available only after you have selected a ll color.
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Group/Buon Description

 

Display The buons in this group let you add margins and set the width. Click the arrow on the Display group
to open the Display window.

Margin Click this buon to dene the amount of white space around the printed output. The available options
are None, Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels
for the top, boom, left, and right margins.

Width Click this buon to select the width of the entire printed output. The available options are Best Fit and
t to Window.

Conguration Seings Editor Folder Structure  
Conguration seings are organized in a hierarchical folder structure. The number of seings in each category folder
display next to the folder name.

Keep in mind that this number varies depending on how you have dened the lters in your search. For instance,
suppose you leave the default selections, Logged In in the Conguration Base eld and Select All in the Type eld of
your search. In this case, all seings, including seings inside each subfolder, will display on the content pane. On the
other hand, if you were to select Site in the Type eld, only the site-level conguration seings would display.

If you have a large site, you may want to consider narrowing your search to return only the seings you need to see.
One way to do this is to lter the seings by category folder. If you know the main folder in which the seings you want
to see are located, select only that folder from the Folders eld.

Expand the folder contents to drill down to only the conguration seings you want to see. For example, you could
navigate to the General folder in Common/General to display all seings in the General folder, including its subfolders.
You could then expand the seings by each subfolder.

This image shows the folders expanded by the Outgoing Email folder in Common/General/Outgoing Email. In this
case, the four conguration seings in the Outgoing Email folder are the only seings that display on the content pane.

Tip:  To display conguration seings in alphabetical order, click in the Key column header.
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Folder Description

Agedatabase Expand this folder to view and edit the batch processing conguration seings that aect Agedatabase
and database maintenance functions.

Chat Expand this folder to view and edit conguration seings used to congure Oracle RightNow Chat
Cloud Service (Chat). The subfolders include General and User Interface.

Common Expand this folder to view and edit conguration seings that apply to the basic functionality of
all Oracle Service Cloud products. The subfolders include Date/Time, General, Knowledge Base,
 Localization, and Oracle Products.

Outreach and Feedback Expand this folder to view and edit conguration seings used to congure Oracle RightNow Outreach
Cloud Service (Outreach) and Oracle RightNow Feedback Cloud Service (Feedback).

RightNow Common Expand this folder to view and edit conguration seings that are common to one or more areas of
Oracle Service Cloud or are used to enable functionality. The subfolders include Intent Guide, 3rd-
Party Applications, Answer Review, ATG Integration, External Integration, Fusion Integration, General
Analytics Options, Message Templates, Mobility, OSN Integration, Screen Pop, Service Modules, Siebel
Integration, SIH, Single Sign-On, Social, and Social Monitor.

RightNow User Interface Expand this folder to view and edit conguration seings used to customize the Service Console and
customer portal. The subfolders include Answer Display Page, Contact Services, Customer Portal, End-
User Interface, General, Login/Session Window, Misc. Customization, Miscellaneous, Open Login,
Sales, Service Level Agreements, Support, and Tool Bar.

Note:  Many of the conguration seings found under the Answer Display Page, Contact
Services, and End-User Interface subfolders apply to the customer portal. See Conguring
Oracle Service Cloud for Customer Portal.

Conguration Seings Editor Audit Log  
The audit log makes it easy for you to see changes that have been made to the conguration seings.

Depending on where you are on the Conguration Seings editor, dierent information displays. For instance, clicking
the Audit Log buon on the ribbon from the main Conguration Seings editor displays the following information about
the changes made.

• Date and time of change

• Who made the change

• Aected interface—Site or interface name

• Conguration seing name

• Old value

• New value

You can also search for a specic conguration seing you want to see changes for from the audit log.

Field Description

When
 

Enter the start and end dates or click the calendars to select the dates for the time period of the
changes you want to see. The current day is the default start date.
 

Relative
 

Select this check box and then click the calendar to enter relative start and end dates.
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Field Description

Who
 

Click this drop-down menu to display changes made by a particular sta member. All is the default.
 

Key
 

Enter the name of a specic conguration seing in this eld.
 

Tip:  You can also enter just the rst few leers and append either the percentage sign (%) or
an asterisk (*) to serve as a wildcard. All seings that begin with the leers you type will be
returned.

Conguration Base
 

Click this drop-down menu and select the interface for which you want to display changes to
conguration seings.
 
All—Displays all site- and interface-specic seings.
 
Logged In—Displays only interface-specic seings for the interface you are logged in to.
 
Site—Displays only site-specic seings that are shared across all interfaces on this site.
 
<interface name>—Displays only interface-specic seings that apply to the selected interface.
 

Note:  Clicking the Audit Log buon with a specic conguration seing open displays changes to that seing
only.

Export Conguration Seing Metadata  
Exporting and importing metadata can save time, especially when you have large numbers of custom seings. You can
export conguration seing metadata and then import that data into another site using the Data Import Wizard.

All aributes associated with conguration seings are available for the interfaces you choose to display. Conguration
seing aributes include ID, key (name), description, enter (site or interface specic), data type, minimum and
maximum value, maximum text length, paern constraint, predened menu, folder and folder ID, default value,
conguration base (site or particular interface), and values.

1. From the Conguration Seings editor, click Meta Data on the ribbon.
The Meta Data window opens.

2. Specify options and enter eld information.

Field Description

Folders
 

Select the folders that contain the conguration seings you want to display. The
Custom folder is selected by default.
 

Key
 

Enter the name of a specic conguration seing in this eld. This eld is not case
sensitive.
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Field Description

Tip:  You can also enter just the rst few leers and append either the
percentage sign (%) or an asterisk (*) to serve as a wildcard. All seings that
begin with the leers you type will be returned.

Type
 

Select the check boxes next to the type of conguration seing you want to display.
 
Select All—Displays all site- and interface-specic seings. (Default)
 
Site—Displays only site-specic seings that are shared across all interfaces on this site.
 
Interface—Displays only those seings that are specic to the interface you are logged
in to.
 

Conguration Base
 

Select the check boxes next to the interfaces for which you want to display conguration
seings.
 
Select All—Displays all site- and interface-specic seings.
 
Logged In—Displays only interface-specic seings for the interface you are logged in
to. (Default)
 
<interface name>—Displays only interface-specic seings that apply to the selected
interface.
 
Site—Displays only site-specic seings that are shared across all interfaces on this site.
(Default)
 

3. Click Search.
Your search results display on the content pane.

4. Click the Options drop-down menu and select  Export > Delimited > Comma .
The Export Options window opens.

5. Specify export options.

Field Description

Location
 

Lists the default location where your CSV le will be saved.
 

Save As
 

Click this buon to open the Save As window where you can specify a location (other
than the default) to save your le.
 

Launch Application
 

Clear this check box if you do not want the le to open after you export it.
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Field Description

Append date/time to le name
using the following format
 

Select this check box to add the date and time to your le name.
 
To change the format in which the date and time is added to your le, enter your
preferred format in the eld next to the check box and then click Reset.
 

Save the selected directory as the
default directory
 

Select this check box to make the directory specied in the Location eld your default
directory.
 

Add report name to output
 

Clear this check box to remove the report name from the CSV le.
 

Note:  You must clear this check box to import the le from the Data Import
Wizard because it uses the value specied in the Header Location eld to
import the data.

6. Click OK.

Now you can import your CSV le from the Data Import Wizard.

Related Topics
• Import Data

How You Customize Conguration Seings  
Conguration seings are used to enable, disable, and congure products and components and many functions and
features. You can customize these seings through the Conguration Seings editor.

Reports drive the data that displays on the content pane, and you can format the output returned using cross tab 
(default) and rollup views. In rollup view, you can edit a single conguration seing for multiple interfaces at one time.

Conguration seings are organized in a hierarchical folder structure and are categorized as either shared across all
interfaces (site specic) or interface specic. Also, when you create a new custom conguration seing, you dene if the
seing will be a site- or interface-level seing. This classication is what lets you view and edit seings across multiple
interfaces at the same time. You can also edit conguration seing values inline on the content pane.

To nd conguration seings, use the Search feature on the Conguration Seings editor. See Search for a
Conguration Seing.

Edit a Conguration Seing  
While standard seings cannot be deleted and their eld parameters cannot be edited, the value of a standard
conguration seing can be edited.

Conguration seing values can be edited either inline or by clicking the Edit Selection buon. You can also edit a single
conguration seing across multiple interfaces at the same time using rollup mode. You can easily see when a value
has been changed from the default value because an underscore displays on the changed value. If you change the value
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back to the default, the underscore no longer displays. When a change is pending, the edited eld displays a tick mark.
When you hover over the tick mark, a tooltip tells you how to save or discard your change.

Tip:  When you rst open the Conguration Seings editor, the Search window opens where you can search
for a specic conguration seing. After you are in the editor, you can click the Search on the ribbon. See
Search for a Conguration Seing.

1. Select the row that displays the conguration seing you want to edit.
2. Do one of the following:

◦ Click Edit Selection. Either the Site window or an interface-specic window opens.

◦ Click in the Value column to edit the seing value inline.

◦ Double-click the seing to open the seing on the content pane and edit the Value eld.

3. Enter or select the new value. Editing options are specic to the eld data type. For example, if a seing can be
enabled or disabled, a Yes/No drop-down menu displays in the Value eld.

4. To revert to the default value, click Restore.
5. Click Save.

The new value displays with an underscore.

You may be required to log out of Oracle Service Cloud and log back in for your changes to take eect.

Edit the Same Conguration Seings Across Multiple Interfaces  
You can edit a single conguration seing across multiple interfaces at the same time using rollup mode.

You cannot edit dierent conguration seings on the same interface at the same time.
1. From the Conguration Seings editor, click Rollup on the ribbon.

The Conguration Seings editor displays in rollup mode.
2. Press Ctrl while selecting the rows you want to edit. You can also press Shift to select multiple consecutive rows.

Note:  Selecting multiple rows across dierent conguration seings will disable the Edit Selection
buon.

3. Click Edit Selection on the ribbon.
4. Enter or select the new value.
5. Click OK.

The values of all the selected rows are updated.
6. Click Save on the ribbon.

The new values display with an underscore.

You may be required to log out of Oracle Service Cloud and log back in for your changes to take eect.

Create a Custom Conguration Seing  
When you create a new conguration seing, it is considered a custom seing. By default, every custom seing name
starts with CUSTOM_CFG_ and is automatically assigned to a Custom folder in the folder hierarchy.

You dene whether your custom seing will be an interface-specic seing or one that is shared across all interfaces
(site specic). For site-specic seings, you can view and edit seings across multiple interfaces at the same time. After
you create a custom seing, you can edit only its value and its folder location.

1. Click New on the ribbon and select the data type: Text, Integer, Menu, Yes/No, or Date/Time.
A new seing opens on the content pane.
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2. Enter eld information.

Field Description

Conguration Entry Information
 

Fields in this section dene the parameters for the custom conguration seing,
 including name, eld type, interface level, folder location, and eld length.
 

*Key
 

Enter the name of your custom conguration seing after CUSTOM_CFG_, which
populates in this eld. All custom seings must start with CUSTOM_CFG_.
 

Data Type
 

The data type you select on the ribbon is populated in this eld.
 

Note:  This is a read-only eld and cannot be edited. If you need to make
changes to the Data Type eld, you must either close the new seing without
saving or delete it if it has been saved.

*Type
 

Click this drop-down menu to select the seing type, either Site or Interface.
 
Site—Classies the custom seing as shared across all interfaces. (Default)
 
Interface—Classies the custom seing as interface-specic only.
 

*Required
 

Click this drop-down menu to dene whether the custom seing is required.
 

*Folder
 

Click the Search icon to dene a folder location for your custom seing. By default, all
custom seings must be located in the Custom folder or a custom subfolder.
 

Note:  Ten subfolders can be nested under the Custom folder. Each subfolder
can contain three child folders.

Default
 

Enter the conguration seing default value in this eld. The format of this eld varies
depending on the data type.
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Field Description

 

*Maximum Length
 

Enter the maximum length allowed in the Value eld of a Text data type eld.
(1-300,000 characters)
 
This eld displays only for Text data types.
 

Paern
 

Enter a regular expression format that the conguration seing value must conform to
in this eld. See Regular Expressions.
 
This eld displays only for Text data types.
 

*Minimum Value
 

Enter the minimum value allowed in the Value eld of an Integer data type eld.
(Limited to -999999999)
 
This eld displays only for Integer data types.
 

*Maximum Value
 

Enter the maximum value allowed in the Value eld of an Integer data type eld. Default
is 99999. (Integer elds can contain up to 9 digits.)
 
This eld displays only for Integer data types.
 

*Predened Menu
 

Click this drop-down to select a predened menu list in the Value eld of a Menu data
type eld. Options include Currencies and Time Zones.
 
This eld displays only for Menu data types.
 

Descriptions
 

This section displays the interface name, language, and description.
 

Description
 

Enter a description of the conguration seing in this eld.
 

Values
 

This section displays the interface type (either site or interface name) and lets you set
custom seing values. If you have more than one interface, you can set a value for each
interface.
 

Value
 

Enter the value of the custom seing in this eld.
 

3. Click Save.

After closing the editor, the custom conguration seing displays in the tree in the Custom folder you saved it in.

You may be required to log out of Oracle Service Cloud and log back in for your changes to take eect.
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How You Congure the Administration Interface  
Conguration seings let you create an administration interface that meets the business needs of your organization.
Some of the most common seings are used to specify security seings, manage notications, dene incident
functionality, categorize tracked links, and congure forecasting for opportunities.

Security seings—Use Oracle Service Cloud security seings to protect your site by conguring how sta members
and customers will access your site, as well as which hosts are allowed access to the administration interface and the
customer portal.

• Learn about the seings related to site protection, passwords, and le aachments in Overview of Security-
Related Conguration Seings. For a complete list of security-related conguration seings, see Security Level.

• For an in-depth discussion about security practices in Oracle Service Cloud and how to protect your data, see
Overview of Oracle Service Cloud Security and Compliance.

Notications—Notications are accessed from the Communications Center navigation list and contain your messages
about system errors and record assignments and updates. Notications can also display reports to show the
performance of incident queues. By default, the Agedatabase utility purges notication messages that are older
than ten days. However, you can change the number of days after which notications are removed by changing
the NOTIF_AGE_DAYS conguration seing. To learn more about the dierent kinds of notications, see Open Your
Notications.

Incidents—You can specify how long incidents remain open, active, and in the database. This table describes the
conguration seings you can use to customize incident life.

To… Use this seing…

Specify how many hours waiting incidents
remain open before being closed
automatically.
 

CI_HOURS
 

Specify which days to use when calculating
how long an incident has been open.
 

CI_WAITING_CALC_DAYS
 

Specify the number of days after which
solved incidents are deleted from the
database.
 

PURGE_DELETE_INCIDENTS
 

Specify the number of days after which
solved incidents go dormant.
 

DORMANT_INCIDENTS
 

Opportunities—You can let sales representatives send quotes as PDF documents, though this option is disabled by
default. Access the SEND_SA_QUOTE_AS_PDF conguration seing to enable this option. See Send a Quote to a
Customer.

Related Topics
• How You Customize Conguration Seings
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How You Customize the Links Menu  
The Links menu, accessed by clicking File, provides quick access to commonly visited URLs. You can customize the links
to meet the needs of your organization.

By default, the list of links includes the customer portal pages of the current interface and the Service Console. You can
customize the links to meet your organization's needs by adding links to other websites your sta members may need
to access. You can also add submenus that contain multiple links. This lets you organize your links by grouping related
links in a single submenu title. This image shows a Links menu with a custom link, a separator, and a submenu with two
links.

Note:  In order for the Customer Portal option to appear on the Links menu, the development area must be
enabled (MOD_CP_DEVELOPMENT_ENABLED in Common/Oracle Products/Modules) and sta members
must have customer portal permissions in their prole. See Conguring Oracle Service Cloud for Customer
Portal.

Using the procedures to add a custom link and to add a submenu with links, you can duplicate the custom links shown
in the gure by dening the value of TBAR_LINK_LIST (RightNow User Interface/Tool Bar/Links) as:

 item(1, "Google","http://www.google.com")
 item(0,"","")
 menu (1, "Oracle Service Cloud",(
 item(1, "Customer Resources","http://www.oracle.com/us/products/
applications/rightnow/resources/index.html")
 item (1,"Discussion Forums","https://cloudcustomerconnect.oracle.com/pages/home")
))

Add a Custom Link  
You can add custom links to appear in the External Links option on the Links menu.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens.
3. Enter TBAR_LINK_LIST in the Key eld and click Search.

The Conguration Seings editor opens with TBAR_LINK_LIST displayed in table format (cross-tab mode).
4. Double-click TBAR_LINK_LIST.

The seing opens in a new tab on the content pane.

272



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Tip:  You can also edit the Value column inline. However, this type of change is easier to make from the
seing tab.

5. Enter the link in the Value eld using the following syntax:
item (#, "<link name>", "<action>")

Field Description

#
 

Enter a link number in this eld. The link number can be any positive integer.
 
0 is reserved for adding separators.
 

“<link name>”
 

Enter the link name as you want it to appear in the Links drop-down menu.
 

“<action>”
 

Enter the URL of the website you want to open when the link is clicked.
 

6. To create another custom link, press Enter to begin a separate line, and enter the link denition as dened in
the Custom Link Syntax table. Enter each link denition on a separate line.

7. To place a separator line between links, enter the following on a separate line between the links where you want
the separator to appear:
item(0,"","")

8. Click Save.

After closing the editor, the new custom links appear in the External Links option on the Links menu after you log out
and then log back in.

Add a Submenu with Links  
You can add a custom submenu and links to appear in the External Links option on the Links menu.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens.
3. Enter TBAR_LINK_LIST in the Key eld and click Search.

The Conguration Seings editor opens with TBAR_LINK_LIST displayed in table format (cross-tab mode).
4. Double-click TBAR_LINK_LIST.

The seing opens in a new tab on the content pane.

Tip:  You can also edit the Value column inline on the content pane. However, this type of change is
easier to make from the seing tab.

5. Enter the submenu name and associated links in the Value eld using the following syntax:
 menu (#, "<menu name>",(
 item (#,"<link name>","<action>")
 item (#,"<link name>","<action>")
 ))
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Field Description

#
 

Enter a number for the option. This submenu or option number can be any positive
integer.
 
0 is reserved for adding separators.
 

“<menu name>”
 

Enter the name of the submenu as you want it to appear on the Links option of the le
menu.
 

“<link name>”
 

Enter the link name as you want it to appear in the Links submenu.
 

“<action>”
 

Enter the URL of the website you want to open when the link is clicked.
 

6. To enter additional links to the submenu, enter more “item” lines using the syntax described in the Custom Link
Submenu Syntax table. Enter each link denition on a separate line.

7. To place a separator line between links of the submenu, enter the following on a separate line between the links
where you want the separator to appear:
item(0,"","")

8. Click Save.

After closing the editor, the new custom submenu and links appear in the External Links option on the Links menu after
you log out and then log back in.

Message Bases Editor  

Search for a Message Base  
Message bases are text strings that appear on the administration interface, the customer portal, and in email messages
and notications. Runtime selectable lters let you dene which message bases display on the content pane. You can
search by interface, category folder, message base name, default text and custom text values.

By customizing message bases with the Message Bases editor, you can change the descriptive text within your
application. Message bases also provide international language support and let you change the text to accommodate
regional dialects.

The rst time you open the Message Bases editor, you must perform a search. Because seings are categorized as
interface specic, the message bases Search window lets you specify what type of message base you want to see.

After you open the Message Bases editor, you can click a message base link and locate the le in the list that appears
in the left column. If you do not know the location of the message base you want to edit, you can run a report of the
message bases to nd the one you want to edit. The report displays each message base label, organized by location,
along with the message associated with each label.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then, double-click Message Bases.

The Search window opens. (The Message Bases editor also opens but is inactive at this point.)
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You have several options on the Search window. You can:

◦ Use the search elds to lter the message bases that are returned on the editor.

◦ Accept all default lters by simply clicking Search to return every message base on the site to which you
are logged in.

◦ Click Cancel to bypass the window and search using the buons on the ribbon or the search elds on the
top of the editor.

◦ Customize the lters and save them as your defaults by selecting Save as Default Values from the
Seings drop-down menu before clicking Search. The next time you access message bases from your
conguration list, the Search window does not open because the system remembers your defaults.
Instead, the Message Bases editor opens with your previously ltered search results.

◦ Design the layout of your Search window by selecting Enter Search Design Mode from the Seings
drop-down menu.

As you congure your application, you will likely use a combination of these options depending on the message
bases you want to access. However, for the purpose of this procedure, we show you how to customize your
search results using the lters on the Search window.

3. Select the lters, sort options, and record limit to be displayed on the editor.

Tip:  If you use the search default seings, every message base on the site you are logged in to will be
returned. If you have a large site, you may want to consider narrowing your search to return only the
message bases you need to see. One way to do this is to lter the message bases by category folder.
If you know the main folder in which the message bases you want to see are located, select only that
folder from the Folders eld.

Field Description

Filters This section displays the runtime selectable lters. If a lter displays a menu list, you
can select all options in the list by selecting the Select All check box, or you can clear all
options in the list by clearing the Select All check box.

Message Base Select the check boxes next to the interfaces for which you want to display message
bases.
Select All—Displays all message bases.
 
Logged In—Displays only message bases for the interface you are logged in to.
(Default)
 
<interface name>—Displays only message bases that apply to the selected interface.
 

Folders Select the folders that contain the message bases you want to display.

Key Enter the name of a specic message base in this eld. This eld is not case sensitive.
You can also enter just the rst few leers and append either the percentage sign (%) or
an asterisk (*) to serve as a wildcard. All message bases that begin with the leers you
type will be returned.
 

Text Enter message base default text (or a portion of the default text) to return message
bases with a value that matches the text you type.
This eld is not case sensitive and accepts blank spaces.
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Field Description

 

Custom Text Enter message base customized text (or a portion of the text) to return message bases
with a value that matches the text you type.
This eld is not case sensitive and accepts blank spaces.
 

Limit and Order This section lets you limit the number of rows returned and how the output should be
sorted.

Limit To This check box, selected by default, limits the number of rows returned. Limiting the
records returned prevents more records being returned than can be easily viewed or
printed.

Rows Enter the number of rows to be returned. The default value of 10,000 is the maximum
number of rows that can be returned per page.
 

Per Page Select this check box to change the number entered in the Rows text box from a hard
limit on the total number of rows returned to a limit on the number of rows returned on
each page. This is automatically selected when you select Limit To.

Order By Click the current sort order next to the Order By eld to select dierent sort options.
The default sort order is displayed with the primary sort eld listed rst, followed by any
subsequent sort elds. The direction each sort eld is ordered in is also indicated (Asc
for ascending order and Desc for descending order). See Change Sort Order Using the
Ribbon and Change Sort Order Using Column Headers.

Seings This drop-down menu gives you options to design and then save your Search window
layout. It also lets you set, restore, and reset your default lter values.

Enter Search Design Mode Select this option to design the layout of your Search window. See Overview of the
Search Window.

Set as Default Layout Select this option to save your search layout as the default.

Restore Default Layout Select this option to reset your search layout to the system default.

Save as Default Values Select this option to save the lter values you select to the local seings on your
workstation. These saved values are used as the defaults the next time you search
and are logged in with the same sta account. Saving your search lters bypasses the
Search window and automatically opens the Message Bases editor to display your
previously ltered search results.

Note:  The default values are overwrien if you select dierent values and
click this buon again. If the search criteria is later edited to change lters, the
default lter values stored in your local seings are ignored.

Restore Default Values Select this option to restore the search values to the default search values. This deletes
saved search values from your local seings.
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Field Description

This buon is disabled if the current search parameters were not populated from your
local seings. See Change Your Personal Seings.
 

Reset Values Select this option to reset the search parameter values to the default values that were
populated when the editor opened. Clicking this buon also resets the Search window to
the default size if it has been resized.

4. Click Search.

Your search results display on the content pane.

Notice that each page is a clickable number across the top of the content pane. The number of folders that displays
depends on which page you view and which seings are displayed. By default, the system displays, at most, 10,000
message bases per page with the folders that the text values are contained in displayed on the left.

How the Message Bases Editor Works  
After performing a search, the Message Bases editor displays your search results on the content pane. Reports drive the
data that displays, and you can choose either cross tab or rollup mode for the layout view.

In rollup view, if you have more than one interface, you can edit a message base across multiple interfaces at one time.
Cross tab is the default. This image shows the Message Bases editor displaying search results in cross tab mode.

Most of the buons on the Message Bases editor ribbon reect common Oracle Service Cloud functionality and work
the same way as they do in reports. For information about working with reports in Oracle Service Cloud, see Overview of
Managing Reports on the Reports Explorer.

Message Bases Editor Home Tab  
From the Home tab on the ribbon, you can create and edit message base text, search and lter the data, dene how
you want the data to display, and export the data in a variety of formats. You can also edit values inline under the text
columns.
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Group/Buon Description

Editing The buons in this group let you edit message base text.

Save Click this buon to save your changes.

Edit Selection Click this buon to open the <interface name> window and edit the text of the selected message base.
In the default cross-tab view, you can edit only one row at a time. Therefore, if more than one row is
selected, this buon is disabled.
 

Lock Click this buon to ensure that the message base text value displays as you expect on update. See Lock
a Text Value.

Note:  Because the custom text value is always used on update, and since the default value
may change with new releases, locking the current value is the only way to ensure that
your text stays the same from release to release. If you have entered a value in the Custom
Text eld, then that value is carried over on update. However, if the Custom Text eld is not
populated, then the default text value is copied into the Custom Text eld. In other words,
 after you click this buon, the text value at that time (either custom text, if the Custom Text
eld is populated, or default text if it is not) is used from that point on, regardless of any
default text value changes in a new release.

Auto Save Click this buon to automatically save your inline edits.

Note:  Auto Save works only for inline edits. The Save buon is disabled when Auto Save is
selected. See Edit an Individual Value Inline and Edit Values in Multiple Rows Using the Ribbon.

Restore Click this buon to return the selected message base to its default value.

Record The buons in this group let you open existing message bases and create and delete custom message
bases.

Open Click this buon to open the selected message base.

New Click this drop-down menu to create a custom message base.

Delete Click this buon to delete a custom message base.
Standard message bases cannot be deleted. Therefore, this buon is available only for custom
message bases.
 

Data Set The buons in this group let you search for message bases, refresh the display, and reset the search
criteria to the defaults.

Search Click this buon to open the Search window and select criteria for runtime selectable lters. See Search
for a Message Base.

Refresh Click this buon to reload the data shown using the current search criteria.

Note:  Refresh works dierently when you edit a message base. If you change a value before
saving, clicking Refresh reverts to the previously saved value.

Reset Click this buon to reload the data shown using the default search criteria.

Find Click this buon to locate text, numeric values, or special characters on the current page. Cells that
contain the search value are highlighted. See Find Content in a Report.

Note:  Find works only on the currently displayed page.
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Group/Buon Description

Find Next Click this buon to highlight the next instance of the search values entered on the Find window.

Clear Click this buon to clear the search values entered on the Find window.

View The buons in this group let you dene display options, view changes that have been made, and
manage failed deployments.

Cross Tab Click this buon to display message bases in a table format. This is the default view.

Rollup Click this buon to display message bases in rollup levels. The data rolls up by message base name. If
you have more than one interface, this view lets you edit multiple rows at the same time for the same
message base. See Dene Rollups and Edit the Same Message Base on Multiple Interfaces.

Audit Log Click this buon to view changes that have been made to the message bases, including when the
change was made, who made the change, the aected message base and name, and old and new
values. You can also use runtime selectable lters to search for specic message bases.

Meta Data Click this buon to select criteria to display the aributes associated with message bases. See Export
Message Base Metadata.

Pending Changes Click this buon to open the Pending Changes window and view changes that failed to deploy during
the save process. You can deploy all changes from this window.
Nothing displays unless there is a failed deployment.
 

Analyze The buons in this group let you sort the displayed data and apply auto ltering, rollups, and slicing to
the data.

Auto Filter Click this buon to enable auto-ltering. Auto-ltering provides column ltering after the report has
been generated. See Enable Auto Filters.

Sort Click this buon to open the Sort window and select which output columns to sort by and the sort
method. See Change Sort Order Using the Ribbon and Change Sort Order Using Column Headers.

Report The buons in this group let you export the data, forward the data in an email, and save and restore
default values.
Permission to export, print, and forward reports must be assigned in your prole for this buon to
display. See Analytics Permissions.
 

Export Click this buon to export the data from a le for use with third-party applications. You can export data
in the following formats: HTML, PDF, Excel, XML, Image, and Delimited. You can also copy data to the
clipboard. See Export Report and Dashboard Data.

Forward Click this buon to send the data to individuals or distribution lists in an email. See Forward a Report.

Print Click the arrow on this buon to access printing options.

Message Bases Editor Page Setup Tab  
The Page Setup tab lets you congure printing options. You can also change the background, margins, and width of
reports.

Each tab has one or more groups containing buons you can use to modify printing or display options. Some groups
have an arrow to the right of the group name that you can click to open a window. For example, you can click the arrow
on the Background group to open the Display Options window.

Windows give you access to the same features you can access from the ribbon, although the windows group the options
dierently, and sometimes contain options not available from the ribbon.
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Group/Buon Description

Print The buons in this group let you congure printing options and add the Page Header and Page Footer
sections. Click the arrow on the Print group to open the Page Setup window. See Print a Report.
This buon group displays only if your prole includes the Print/Export/Forward Reports permission.
See Analytics Permissions.
 

Print Margin Click this buon to select the size of the margins used when printing. The available options are Normal,
 Narrow, Medium, and Wide.

Size Click this buon to select the paper size. The available options are Leer, Legal, Executive, A3, A4, and
A5.

Portrait/Landscape Click these buons to print in portrait or landscape mode.

Page Header/Page Footer Select these check boxes to include a page header and page footer when printing the report.

Print to Fit Select this check box to scale your output to your printer default page width and send it to the printer.

Background The buons in this group let you add a background color. You can add a gradient color to blend into
the primary color and choose how intense the colors should be with the Transparency seing. Click the
arrow on the Background group to open the Display window.

Fill Color Click this drop-down menu to select a background color.

Gradient Click this drop-down menu to apply a gradient to the background.
This option is available only after you have selected a ll color.
 

Transparency Click this drop-down menu to apply a transparency to the background.
This option is available only after you have selected a ll color.
 

Display The buons in this group let you add margins and set the width. Click the arrow on the Display group
to open the Display window.

Margin Click this buon to dene the amount of white space around the printed output. The available options
are None, Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels
for the top, boom, left, and right margins.

Width Click this buon to select the width of the entire printed output. The available options are Best Fit and
t to Window.

Message Bases Editor Folder Structure  
Message bases are organized in a hierarchical folder structure. The number of message bases in each category folder
display next to the folder name. Keep in mind that this number varies depending on how you have dened the lters in
your search.

By default, the system displays a maximum of 10,000 message bases per page with the folders that the text values are
contained in displayed on the left. Each page is a clickable number across the top of the content pane.

If you have a large site, you may want to consider narrowing your search to return only the message bases you need
to see. One way to do this is to lter the message bases by category folder. If you know the main folder in which the
message bases you want to see are located, select only that folder from the Folders eld.

Expand the folder contents to drill down to only the message bases you want to see. For example, you could navigate to
the Global Date Lists folder in Common/Global Date Lists to display all message bases in the Global Date Lists folder,
including its subfolders. You could then expand the message bases by each subfolder.
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This image shows the folders expanded by the Messages folder in Common/Email/Messages. In this case, the ve
message bases in the Messages folder are the only message bases that display on the content pane.

Tip:  To display message bases in alphabetical order, click in the Key column header.

Message Bases Editor Audit Log  
The audit log makes it easy for you to see changes that have been made to the message bases. Depending on where
you are on the Message Bases editor, dierent information displays.

For instance, clicking Audit Log on the ribbon from the main Message Bases editor displays the following information
about the changes made.

• Date and time of change

• Who made the change

• Aected interface

• Message base name

• Old value

• New value

You can also search for a specic message base you want to see changes for from the audit log.

Field Description

When Enter the start and end dates or click the calendars to select the dates for the time period of the
changes you want to see. The current day is the default start date.

Relative Select this check box and then click the calendar to enter relative start and end dates.

Who Click this drop-down menu to display changes made by a particular sta member. All is the default.

Key Enter the name of a specic message base in this eld.

Tip:  You can also enter just the rst few leers and append either the percentage sign (%) or
an asterisk (*) to serve as a wildcard. All message bases that begin with the leers you type
will be returned.

Message Base Select the check boxes next to the interface for which you want to display changes to message bases:
• All—Displays all message bases. (Default)
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Field Description

• Logged In—Displays only message bases for the interface to which you are logged in.

• <interface name>—Displays only message bases that apply to the selected interface.

Note:  Clicking Audit Log on the ribbon with a specic message base open displays changes to that message
base only.

Export Message Base Metadata  
Exporting and importing metadata can save time, especially when you have large numbers of message bases. You can
export message base metadata and then import that data into another site using the Data Import Wizard.

All aributes associated with message bases are available for the interfaces you choose to display. Message base
aributes include ID, key (name), enter (site or interface specic), description, maximum length, folder and folder ID, and
text and custom text values.

1. From the Message Bases editor, click Meta Data on the ribbon.
The Meta Data window opens.

2. Specify options and enter eld information.

Field Description

Folders Select the folders that contain the message bases you want to display. The Custom
folder is selected by default.

Key Enter the name of a specic message base in this eld. This eld is not case sensitive.
You can also enter just the rst few leers and append either the percentage sign (%) or
an asterisk (*) to serve as a wildcard. All message bases that begin with the leers you
type will be returned.
 

Message Base Select the check boxes next to the interfaces for which you want to display message
bases:

◦ Select All—Displays all site- and interface-specic message bases.

◦ Logged In—Displays only interface-specic message bases for the interface to
which you are logged in. (Default)

◦ <interface name>—Displays only interface-specic message bases that apply to
the selected interface.

3. Click Search.
Your search results display on the content pane.

4. Click the Options drop-down menu and select  Export > Delimited > Comma .

The Export Options window opens.
5. Specify export options.

Field Description

Location
 

Lists the default location where your CSV le will be saved.
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Field Description

Save As
 

Click this buon to open the Save As window where you can specify a location (other
than the default) to save your le.
 

Launch Application
 

Clear this check box if you do not want the le to open after you export it.
 

Append date/time to le name
using the following format
 

Select this check box to add the date and time to your le name.
 
To change the format in which the date and time is added to your le, enter your
preferred format in the eld next to the check box and then click Reset.
 

Save the selected directory as the
default directory
 

Select this check box to make the directory specied in the Location eld your default
directory.
 

Add report name to output
 

Clear this check box to remove the report name from the CSV le.
 

Note:  You must clear this check box to import the le from the Data Import
Wizard because it uses the value specied in the Header Location eld to
import the data.

6. Click OK.

Now you can import your CSV le from the Data Import Wizard.

Related Topics
• Import Data

How You Customize Message Bases  
Message bases are text strings that appear on the administration interface, the customer portal, and in email messages
and notications. You can customize these with the Message Bases editor.

By customizing message bases with the Message Bases editor, you can change the descriptive text within your
application. Message bases also provide international language support and let you change the text to accommodate
regional dialects.

Reports drive the data that displays on the content pane, and you can format the output returned using cross tab
(default) and rollup views. In rollup view, you can edit a single message base for multiple interfaces at one time. Like
conguration seings, message bases are organized in a hierarchical folder structure.

To nd message bases, use the Search feature on the Message Bases editor described in the Search for a message base
procedure.

When the Message Bases editor opens, each page is a clickable number across the top of the content pane. By default,
the system displays, at most, 10,000 message bases per page with the folders that the text values are contained in
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displayed on the left. The number of folders that displays depends on which page you view and which seings are
displayed.

Edit Message Base Text  
While standard message bases cannot be deleted and eld parameters cannot be edited, the text values of standard
message bases can be edited inline or from the ribbon. You can also edit the same message base on multiple interfaces
at once using rollup mode.

You can easily see when a text value has been changed from the default value because an underscore displays on
the changed value. If you change the value back to the default, the underscore no longer displays. When a change is
pending, the edited eld displays a tick mark. When you hover over the tick mark, a tooltip displays telling you how to
save or discard your change.

Another feature you’ll want to know about is the ability to lock your message base text values to ensure that the text
displays as you expect on update. Because the system always uses the custom text value on update, and since the
default value may change with new releases, locking the current value is the only way to ensure that your text stays the
same from release to release. See the procedure that follows to lock your text values.

CAUTION:  We recommend that you document all changes made to the message bases. As you continue to
edit the message bases, your installation becomes less similar to the documentation and the default product.
In some cases this can make training and troubleshooting more dicult. Before you begin editing a message,
you may want to copy the existing message text from the Default Text eld and paste it into the Description
eld of the open message base. This reduces the chance of errors if you ever need to change your edited
message back to the previous value.

1. Select the row that displays the message base you want to edit.

Tip:  When you rst open the Message Bases editor, the Search window opens where you can search
for a specic message base. After you are in the editor, you can click the Search on the ribbon. See
Search for a Message Base.

2. Do one of the following:

◦ Click Edit Selection on the ribbon. The <interface name> window opens.

◦ Click in the Text column to edit the text value inline.

◦ Double-click the message base to open it on the content pane and edit the Description eld and/or the
Custom Text eld.

3. To edit the message base description, enter your changes in the Description eld.
4. Enter or select the new custom text value.

Note:  Do not add hard returns to message base text. Hard returns may cause a JavaScript error to
occur on the page or window where the text appears.

5. To revert to the default text value, click Restore.
6. Click Save.

The new custom text displays with an underscore.
7. Verify the change by checking the page where the edited message base appears.

Changes to the message bases do not take eect immediately. You must log out of Oracle Service Cloud and log back in
or refresh the customer portal page.

Edit the Same Message Base on Multiple Interfaces  
You can edit the same message base on multiple interfaces.
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You cannot edit dierent message bases on the same interface at the same time.
1. From the Message Bases editor, click Rollup on the ribbon.

The Message Bases editor displays in rollup mode.
2. Press Ctrl while selecting the rows you want to edit.
3. Click Edit Selection on the ribbon.
4. Enter the new text value.
5. Click OK.

The values of all the selected rows are updated.
6. Click Save.

The new values display with an underscore.
7. Verify the changes by checking the pages where the edited message bases appear.

Changes to the message bases do not take eect immediately. You must log out of Oracle Service Cloud and log back in
or refresh the customer portal page.

Lock a Text Value  
If you have dened a value in the Custom Text eld, you can lock that value and it will be used on update.

1. Select a message base from the Message Bases editor.
2. Click Lock on the ribbon.

If you have dened a value in the Custom Text eld, then that value is locked and will be used on update. If the Custom
Text eld is not dened, then the default text value is copied into the Custom Text eld and that value is locked. Either
way, the text value will be used from that point on, regardless of any default text value changes in a new release.

Tip:  If you have more than one interface, you can lock multiple message bases at the same time by displaying
the report in rollup view.

Create a Custom Message Base Entry  
When you create a new message base entry, it is considered custom. By default, every custom message base entry
name starts with CUSTOM_MSG_ and is automatically assigned to a Custom folder in the folder hierarchy.

After you create a custom message base entry and save it, you can edit its label with custom text. You can also edit the
Description eld at this point.

1. Click New on the ribbon.
A new message base entry opens on the content pane.

2. Enter eld information.

285



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

Message Base Entry Information Fields in this section dene the parameters for the custom message base, including
name, eld length, description, folder location, entry type, default text, and custom text.

*Key Enter the name of your custom message base after CUSTOM_MSG_, which populates in
this eld. All custom message bases must start with CUSTOM_MSG_.

*Maximum Length Enter the maximum length allowed in the Custom Text eld (1-300,000 characters).

Description Enter a description of the message base in this eld.

*Folder Click the Search icon to dene a folder location for your custom message base. By
default, all message bases must be located in the Custom folder or a custom subfolder.
Ten subfolders can be nested under the Custom folder. Each subfolder can contain three
child folders.
 

*Entry Type Select from the drop-down menu to add a plain, HTML, or hot key aribute to your
message base. Both the Default Text and Custom Text elds accept plain, HTML, and
hot key aributes. The HTML option lets you apply HTML to your text. For example, if
you want your text to display in bold, you could enter <b>Bold text</> in the elds.
The Hotkey option lets you add a keyboard shortcut to your text by prepending an
ampersand (&) to the text you enter in the elds.

Default Text This eld is not required; however, if you plan to export and then import your message
bases, you must enter a value in this eld (or under the Values section). Otherwise, the
data import will return an error.
Enter the default text that you want to display on all interfaces. The text you enter in this
eld populates the Default Text elds for all interfaces under the Values section.
 

Note:  If you want your interfaces to display dierent default text, leave this
eld blank and enter your default text values in each interface row under the
Values section.

Values This section displays the interface name and lets you set your default text for each
interface.

Default Text Enter the default text you want to display for each interface.

Custom Text Enter the custom text you want to display on each interface. If you dene a value in this
eld, it overwrites the value in the Default Text eld.
This eld is disabled until you save your new custom message base. In other words, this
eld can be edited only on existing message bases.
 

3. Click Save.
Now that you have saved your message base, you can edit the Custom Text eld.

4. To dene a value for custom text, enter it in the Custom Text eld.
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Note:  If you dene a value for this optional eld, it overwrites the value in the Default Text eld.

5. Click Save and Close.
The custom message base displays in the tree under the Custom folder you saved it in.

6. To preserve your text value on update, you must lock the text value.

Changes to the message bases do not take eect immediately. You must log out of Oracle Service Cloud and log back in
or refresh the customer portal page.

Manage Files with the File Manager  
The File Manager provides direct access to les located on the hosting servers that can be used to customize your
organization’s application. Using the File Manager, you can view, edit, replace, and back up les that control many
aspects of Oracle Service Cloud.

By default, the File Manager provides access to the most commonly modied les. For descriptions of the directories
and les that are accessible using the File Manager, see File Manager Directories.

CAUTION:  Changes to the les available in the File Manager may immediately aect what customers and
sta members see. Because changes to these les can have signicant impact, you may want to give only
certain sta members access to the File Manager. You can grant or deny access to the File Manager through
the Conguration permission on the Administration tab of the sta member’s prole. See Proles.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.

The File Manager opens on the content pane.

Note:  By default, the mail/cci directory displays when you open the File Manager. However, the mail
les are read-only. You can, however, copy any existing le to use in the content of your organization’s
system-generated notications and emails. See Overview of Message Templates.

The Available Interfaces section contains links to the available interfaces for this installation of Oracle Service
Cloud. On the right, you can select a directory from the Switch To drop-down menu to navigate to another
directory. This section contains all the les located in the selected directory. Using the Upload function, you can
upload a supported le to the current directory by browsing for the le.

Field/Buon Descriptions

Available Interfaces Select the interface for viewing or editing les in the File Manager.

Switch to Click this drop-down menu to select the directory you want to open. For information
about directory structure and individual les, see File Manager Directories.

Name This column displays the view/edit buon with the le name or the folder icon with the
folder name.

Click this buon to open a folder or subfolder.

Click this buon to view or edit .php and .js les.
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Field/Buon Descriptions

Click this buon to view or edit .css, .moddefs, .tlx, and .xml les.
 

Click this buon to view or edit .gif, .jpg, and .png les.

Click this buon to view or edit .html les.

Click this buon to view or edit .txt and .utf8 les.

Size This column displays the size (in kilobytes) of the folder or le.

Modied This column displays the date that the folder or le was last modied.

Action This column displays the actions you can take for each le, including download, move,
 copy, restore, and delete.

 Download Click this buon to download the le to your workstation. See Download a File.

Copy Click this buon to copy or move the le. See Copy or Move a File.

Note:  You cannot move an original le, only a copy.

Restore Click this buon to restore the le to the original default conguration or the last saved
backup copy. See Restore a File from the Backup or Default Directory.

Delete Click this buon to delete a le. Only copied, moved, and uploaded les can be deleted.
See Delete a File.

Upload Enter the path and name of the le you want to upload to the server in this text box. See
Upload a File.

Browse Click this buon to browse for the le you want to upload.

Go Click this buon to upload the le to the directory in which you are currently located. A
le must be specied in the Upload eld.

Comment Enter a comment to the log le in this eld.

Backup and Default Files  
Each directory accessible through the File Manager has an associated backup and default directory.

The File Manager automatically saves a backup le in the backup directory when a le is uploaded, edited, or restored. It
also maintains permanent, read-only copies of the originally installed default les in the default directory. If necessary,
les that have been edited can be restored from the default le or the backup copy using the restore function. See
Restore a File from the Backup or Default Directory.
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Note:  The les in the backup and default directories cannot be edited or overwrien, only viewed and
downloaded.

We strongly recommend backing up all customized les on a disk, computer, or network so in the event that you need
to revert to an old version of a le, you can restore to a working le. For information about making a backup copy of a
le using the download feature, see Download a File. For information about making a temporary backup copy of a le
using the copy feature, see Copy or Move a File.

Related Topics
• Manage Files with the File Manager

Download a File  
By downloading a le, you can edit the le locally to obtain the desired results, and then upload the le to the server.
The download function also lets you save backup copies of your customized les.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.

The File Manager opens on the content pane.
3. Select the directory that contains the le from the Switch To drop-down menu.
4. Click the Download icon in the Action column for the le you want to download.

A message asks you to save the le or nd a program to open it.
5. Click Save to open the Save As window.
6. Navigate to the directory where you want to save the le and enter the name of the le.
7. Click Save to download the le to the selected directory on your workstation.

Related Topics
• Manage Files with the File Manager

Upload a File  
You can upload les to the hosting facility. This direct access to les on the server gives you the ability to manage les
and provides you with a convenient interface for uploading and downloading les.

In the wordlist and dictionary directories, you can upload only those les that already exist in the directory. For example,
if you try to upload a le called mydict.txt to the dictionary directory when the actual le is userdic.tlx, an error message
displays and the upload does not execute.

Note:  Only certain le types can be uploaded through the File Manager. For a list of le types that can be
uploaded into each directory, see File Manager Directories.

1. Select the directory that contains the le from the Switch To drop-down menu.
2. Do one of the following:

◦ Enter the full path of the le you want to upload in the Upload eld.

◦ Click Browse to open the Choose File window where you can search your local and network le systems
for the le. Select the le and click Open.

The le path and name populates the Upload text box.

A le name cannot include spaces or special characters. In addition, a le name that includes uppercase
characters is converted to lowercase when it is uploaded. After the le is uploaded, it can be copied with a new
name if the le requires a name with uppercase characters. See Copy or Move a File.
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3. Click Go to upload the le to the current directory.

If the uploaded le has the same le name and extension as the le you want to replace, it automatically overwrites the
le. A backup copy of the current le is saved in the backup directory before the le is overwrien.

Related Topics
• Manage Files with the File Manager

View a File  
You can view a le to help you identify the le purpose or to help you troubleshoot issues.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.

The File Manager opens on the content pane.
3. Select the directory that contains the le from the Switch To drop-down menu.
4. Click the View/Edit icon to the left of the le you want to view.

The contents of the le are displayed on the content pane.
5. Click Cancel to return to the main File Manager page when you have nished viewing the le.

Note:  When viewing or editing a le through the File Manager, you may need to scroll down to see the
Save and Cancel buons.

Related Topics
• Manage Files with the File Manager

Edit a File  
The File Manager lets you edit les located on the hosting server.

1. From the File Manager, click the name of the le you want to edit or click the View/Edit icon to the left of the
le.

2. Edit the le as necessary.
3. Enter a brief comment in the Comment eld to help you track the editing history. For information about

viewing comments, see Log File Management.
4. Click Save.

A backup copy of the current le is saved in the backup directory and the current le is overwrien with the modied
le. Because saving a le impacts the backup copy of the le, you will receive a warning if you aempt to save the le
without making any changes.

Related Topics
• Manage Files with the File Manager

Copy or Move a File  
You can copy or move a le to the current directory or the backup directory to organize and back up your les. However,
you cannot move or overwrite the les in the default directories.

When copying les, you may want to adopt a naming convention for old or backup copies of a working le. The File
Manager default le name is copy_<lename>. Be consistent with whatever naming convention you choose.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.
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The File Manager opens on the content pane.
3. Select the directory that contains the le from the Switch To drop-down menu.
4. Click the Copy icon in the Action column of the le you want to copy or move.
5. To move the copy of the le to the backup directory, select it using the directory drop-down menu in the current

directory.
6. To change the resulting le name from the default copy_<lename>, enter the new name in the text box to the

right of the directory drop-down menu.
7. Click Save to copy or move the le to the specied directory and le name.
8. Enter a brief comment in the Comment eld to help you track the editing history. For information about

viewing the editing history, see Log File Management.
9. To create additional copies of the same le, repeat steps 3 through 8.

10. Click Cancel to return to the directory where the copied le is located.

Related Topics
• Manage Files with the File Manager

Restore a File from the Backup or Default Directory  
You can restore a le to the most recent backup copy in the backup directory or to the original default le in the default
directory. You might choose this option if you are having problems editing a le and want to revert to an earlier version.

Read-only, backup copies of all les accessible through the File Manager are created in each default directory during
installation to serve as permanent backup copies. Before a le is overwrien (edited, uploaded, or restored), a backup
copy is saved in the backup directory. When you use the restore function and there is both a backup and default le, you
are prompted to choose which le you want to restore. If only one le exists, either a default le or a backup le, a dialog
box prompts you to conrm the restoration from the existing le.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.

The File Manager opens on the content pane.
3. Select the directory that contains the le you want to restore from the Switch To drop-down menu.
4. Click the Restore icon in the Action column of the le you want to restore.

A warning message asks you to verify that you want to restore the le.
5. Click OK.

If both backup and default les exist, you are prompted to choose either the backup or default le.
6. To restore from the default le, select Default and click Commit to return to the directory list of les.
7. To restore from the backup le, select Backup and click Commit to return to the list of les.

Related Topics
• Manage Files with the File Manager

Delete a File  
You can delete copies of les or uploaded les that you no longer need. However, you can delete only those les that
you have copied, moved, or uploaded.

You cannot delete the original les that were created during installation or update. Before the le is deleted, a copy of
the le is saved in the backup directory.

CAUTION:  Deleting a le can aect your production site. Be sure that the le you are deleting is not necessary
for proper functioning of your site. Always make backup copies of les that you may need in the future.
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1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.

The File Manager opens on the content pane.
3. Select the directory that contains the le you want to delete from the Switch To drop-down menu.
4. Click the Delete icon in the Action column of the le you want to delete.

A warning message asks you to continue or cancel the action.
5. Click OK to delete the le.

Related Topics
• Manage Files with the File Manager

File Manager Directories  
The File Manager gives you access to the directories described here along with access to the backup and default
directories.

• Mail les—The PHP les in the ma/cci directory as well as the les in the expanded File Manager have been
deprecated and may be permanently removed in a future release. You can customize your message content,
including headers and footers, using message templates instead of making changes to multiple PHP les. See
Overview of Message Templates.

Note:  The mail les display as read-only in the File Manager so that you can copy any existing
message content to your organization’s system-generated notications and emails, which are dened
by the message templates.

• CSS les— This directory has been deprecated and is not used by standard Oracle Service Cloud functionality.
You can upload and download CSS les to the customer portal assets folder through WebDAV. See Overview of
WebDAV, View Customer Portal Files, Customer Portal Page Sets, and Customer Portal Folder Structure.

• Custom scripts—This directory is used to store legacy les for any customization work done on your site.

• Outreach and Feedback les—Using the default les in the ma/cci directory, you can customize pages used
with Outreach and Feedback mailings and surveys. These directories do not display if Outreach and Feedback
is not enabled.

File Description

boom.phph
 

Used to add page elements to the boom and right of HTML pages that have been
generated by PHP scripts.
 

head.phph
 

Used to link to a cascading style sheet to add head elements to the HTML pages that
have been generated by the PHP scripts.
 

top.phph
 

Used to add page elements to the top and left of HTML pages that have been generated
by PHP scripts.
 

To learn more about customizing mailing and survey pages, see  Answer ID 2477  on our support site.

• Image les—This directory has been deprecated and is not used by standard Oracle Service Cloud functionality.
You can upload and download image les to the customer portal assets folder through WebDAV. See the cross-
references listed under CSS les above.
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• Chat le directories—The Chat image les directory contains the images used in Chat, including the logo used
on the client window. The Chat Agent transcript images directory contains the images used to modify the
Transcript section of the chat sessions workspace. The Chat Agent transcript templates directory contains
the style sheet, JavaScript le, and HTML template used to modify the Transcript section of the chat sessions
workspace. These directories do not display if Chat is not enabled.

• Wordlist les—The les in this directory enable you to customize the words used during keyword indexing, text
searching, and SmartSense rating. See SmartSense and Wordlist Files for more details.

• Asian language dictionaries—The Asian language dictionaries directory contains additional dictionary word
lists that are used for part-of-speech (POS) tagging and similar phrase searching. See Asian Language
Dictionaries for more information.

• Spellchecker dictionaries—The spellchecker dictionary directory, spell/dict, contains an additional dictionary
word list, userdic.tlx, which is used for spell checking and similar phrase searching. Add words you want to be
included in the spell checking dictionary. Words added to this le are not agged as misspelled during spell
checking. Enter each word on a separate line.

• Integration les—The les in this directory are templates used for external events and email integration.
Contact your Oracle account manager for help with these les.

• Certicate directories—The Additional root certicates, Intermediate certicates, and Certication revocation
lists directories are used to store les used for email security. See Email Security Features.

• Log le—The log le is a useful tool for tracking the history of a le. It records the details of the actions taken
on a le (for example, uploading, restoring, copying, or deleting), including the sta member who executed the
action, the IP address of the sta member’s workstation, the date and time of the action, and comments. See
Log File Management for more information.

Wordlist Files  
The les in this directory let you customize the words used during keyword indexing, text searching, and SmartSense
rating.

Note:  The Wltool utility runs automatically after editing these les. However, if you edit the
exclude_incidents.txt or exclude_answers.txt les, the Keywordindexer utility must run by Oracle Cloud
Operations before your changes become active. To schedule this, submit a service request on our  support site
.

File Description

aliases.txt
 

This le is initially empty, but you can add synonyms, phrases, or aliases to link terms specic to your
industry to similar terms that may be used during a search. For example, a customer might search for
an acronym, such as “GPS,” but all of your answers regarding GPS might spell out “global positioning
system” rather than using the initials. The aliases.txt le lets you link terms that customers might
search on with synonymous terms in your answers.
 
The rst word in the line is the search word that customers can enter. It can contain spaces so you can
use phrases as synonyms for the search word. It cannot contain ampersands or slashes, although it
can contain hyphens. All entries on the line must be uppercase and comma delimited, as shown in this
example:
 
GPS, GLOBAL POSITIONING SYSTEM, NAVIGATIONAL SYSTEM
 
If a customer enters the rst word in a line as a search word, all answers containing that word or any
other term on the line are returned. In this example, a customer who enters GPS as a search word is
directed to all answers containing “GPS,” “global positioning system,” or “navigational system.”
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File Description

do_not_suggest.txt
 

This le is initially empty, but you can add terms you do not want to appear in Suggested Searches on
the Answers page. Enter each word on a separate line of the text le.
 

exclude_answers.txt
 

This le contains common words such as prepositions, adverbs, and pronouns that are excluded from
indexing and searching functions on the customer portal. If you have specic words that you do not
want customers to be able to search on, you can add these stopwords to the exclude_answers.txt le to
exclude them from being indexed. Stopwords must be uppercase and entered on separate lines.
 

Note:  Words in this le are also excluded when using SmartAssistant to search for an answer.

exclude_incidents.txt
 

This le contains common words such as prepositions, adverbs, and pronouns that are excluded from
indexing and search functions on the administration interface. If you have specic words that you do
not want agents to be able to search on, you can add these stopwords to the exclude_incidents.txt le
to exclude them from being indexed. Stopwords must be uppercase and entered on separate lines.
 

Note:  SmartAssistant does not exclude words from exclude_incidents.txt when searching
incidents on the administration interface or the customer portal.

exclude_responses.txt
 

This le contains common words such as prepositions, adverbs, and pronouns that are excluded from
use in clustering responses. If you have specic words that you do not want agents to be able to search
on, you can add these stopwords to the exclude_responses.txt le to exclude them from being indexed.
Stopwords must be uppercase and entered on separate lines.
 

smartsense.txt
 

This le contains emotive override words and values that are checked before the standard emotive
word list. You can add unrated words, give dierent ratings to already rated words, or remove words.
Each word is rated between -10 and +10. Word values are used for internal calculations to result in the
nal displayed SmartSense ratings of +3 to -3. The word and its value must be separated by a tab and
entries must be entered on separate lines. Any changes aect new incidents, updated incidents, and
text question responses in surveys. When adding words to this le, you must add all forms of the word
(on separate lines), not just the root word.
 

thesaurus.txt
 

This le contains a list of words and their synonyms used in the Similar Phrases search technique
on the Answers page. Words in the text search are matched with synonyms to extend the searching
capability to include ontologies. The word and its synonyms must be uppercase and comma delimited
as seen in this example:
 
ABIDE, BIDE, STAY, ENDURE, STOMACH, BEAR, STAND, TOLERATE, BROOK, SUFFER
 
where ABIDE is the main word and BIDE, STAY, ENDURE, and so on are synonyms. In thesaurus.txt,
 each word in the list is a synonym of the rst word, not synonyms of each other. For example, the word
“abide” has the synonyms “stay” and “endure.” Endure has no synonyms, unless “endure” had its own
entry.
 

Note:  The synonyms can be multi-word phrases, but the rst term in the line must be a
single word.

Related Topics
• SmartSense
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Asian Language Dictionaries  
The Asian language dictionaries directory contains additional dictionary word lists that are used for part-of-speech
(POS) tagging and similar phrase searching. By adding words to the user dictionary les with special parameters, you
can override the default segmentation.

Note:  User dictionary les are available only for Chinese and Japanese languages, specically Mandarin
(user.dict_CN.utf8), Cantonese (user.dict_HK.utf8), Taiwanese (user.dict_TW.utf8), and Japanese
(user.dict_JP.utf8).

You can create user dictionaries for words specic to an industry or application by adding new words, personal names,
and transliterated characters of other alphabets. In addition, you can specify how existing words are segmented.
For example, you may want to prevent a product name from being segmented even if it is a compound. The system
performs a lookup of more than 500,000 words to determine segmentation. Using the dictionary, alias list, and
keywords, you can inuence how words are segmented.

If you edit a user dictionary le, you must use a specic format. The word you want to add is followed by the user
dictionary part-of-speech tag (listed below), and an optional decomposition paern (DecompPaern) in the form of a
comma-delimited list of numbers specifying the number of characters from the word to include in each component of
the string. (Use a zero (0) to indicate that a DecompPaern is not needed.)

For example, the user dictionary entry AABBCC ORGANIZATION 2,2,2 indicates that AABBCC should be decomposed
into three, two-character components.

User Dictionary POS Tags for Mandarin, Cantonese, and Taiwanese (case insensitive)

• NOUN

• PROPER_NOUN

• PLACE

• PERSON

• ORGANIZATION

• FOREIGN_PERSON

User Dictionary POS Tags for Japanese (case insensitive)

• NOUN

• PROPER_NOUN

• PLACE

• PERSON

• ORGANIZATION

• GIVEN_NAME

• SURNAME

• FOREIGN_PLACE_NAME

• FOREIGN_GIVEN_NAME

• FOREIGN_SURNAME

Note:  Oracle Cloud Operations must run the Keywordindexer utility before your changes to the word list les
are active. To schedule this, submit a service request on our  support site .
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Log File Management  
The log le is a useful tool for tracking the history of a le. It records the details of the actions taken on a le.

You can send the log le through email or download the log le to your workstation in either CSV (comma-separated
value, or comma-delimited) or HTML format.

Field/Buon Description

File Name
 

This eld displays the name of the le.
 

User
 

This eld displays the sta member who executed the logged action.
 

IP Address
 

This eld displays the IP address of the workstation the logged action was executed from.
 

Date/Time
 

This eld displays the date and time that the logged action occurred.
 

Change Type
 

This eld describes the type of logged action (for example, upload, default restore, backup restore,
 copy, or delete).
 

Comment
 

This eld contains any comments that were added by the sta member during the logged action.
 

Your Email Address
 

Enter your email address to be used as the From address when the log le is sent.
 

Send the Log File To
 

Enter the email address to which you want to send a copy of the log le.
 

Email Log File
 

Click this buon to send the log le by email.
 

Comma Delimited (CSV)
 

Select this option to download the log le in CSV format.
 

HTML
 

Select this option to download the log le in HTML format.
 

Download Log File
 

Click this buon to download the log le to your workstation.
 

You can email and download the log le.

Email the Log File  
You can send the log le through email.

1. Enter your email address in the Your Email Address eld.
This will be the From address.

2. Enter the recipient’s email address in the Send the Log File To eld.
3. Click Email Log File.
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Download the Log File  
You can download the log le to your workstation in either CSV (comma-separated value), comma-delimited, or HTML
format.

1. Select the format for downloading the le (Comma Delimited, CSV, or HTML).
2. Click Download Log File.
3. Select the location where you want the le saved and click Save.

Log File Errors and Information  
Log les let you view errors and other information generated by the CGI and PHP scripts, the Techmail and Agedatabase
utilities, and Oracle Service Cloud products.

The log les can be helpful in troubleshooting issues with your Oracle Service Cloud application. These log les are
available:

• Error log—This log contains application and data errors.

• Info log—This log contains informational errors, such as processing too much data.

• Security log—This log contains security errors, such as an invalid security string.

• External Search log—This log describes external searches of your site pages performed by spiders or robots.
See Overview of Finding Content on the Customer Portal.

• Rule log—This log describes the business rules that have red against a specied record. See Verify a Rule
Using the Rule Log.

Open Log Files  
Open log les to view information in the error, info, and security logs.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Logs.

The content pane displays the log viewer.
3. Click Error Log, Info Log, or Security Log on the ribbon to open the corresponding log le.
4. Select options from the Log File drop-down menus.

Field Description

Interface
 

Click this drop-down menu and select the interface of the logs you want to view.
 

Application
 

Click this drop-down menu and select the application for which you want to view
messages. By default, All is selected in the menu to display messages associated with
any of the applications. The following options are available.
 

◦ All

◦ Agedatabase

◦ Bulkdel

◦ Certool

◦ Dataminer
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Field Description

◦ DBAudit

◦ DBStatus

◦ DBUpdate

◦ DQA

◦ Kexport

◦ Keyword Indexer

◦ Kimport

◦ Lang CVT

◦ Mailer

◦ Messagebase Compiler

◦ Oracle Service Cloud

◦ Oracle Service Cloud PHP

◦ Oracle Service Cloud Upgrade

◦ RD

◦ Reportgen

◦ Sawmill

◦ Techmail

◦ Unknown

◦ WLTool

When you open the error, info, or security logs, all messages in the log are displayed and
are grouped together by application. You can click the header for each group to expand
or collapse the messages listed in the group.
 

Error type
 

Click this drop-down menu and select the type of messages that you want to view. The
following options are available.
 

◦ All—Select this option to see all types of messages. This is selected by default
when you open the log le.

◦ Campaign—Select this option to see messages generated by campaigns.

◦ Conguration—Select this option to see messages generated when using the
Conguration Seings editor.

◦ Internal—Select this option to see internal server errors.

◦ POP3 Protocol—Select this option to see messages returned by Techmail when it is
trying to retrieve email from the Service or Outreach mailboxes.

◦ Rules—Select this option to see messages generated when rules are being
processed.

◦ SMTP Protocol—Select this option to see messages created by Techmail when it is
trying to send email.

◦ SQL—Select this option to see SQL messages returned by the database
management system.

◦ SSL—Select this option to see messages created with email using SSL.

298



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

◦ Unclassied Bounce Message—Select this option to see messages generated
when an Outreach email is bounced for a reason that cannot be classied.

The columns in the error, info, and security logs display the name of the application that generated the
message, the error type, and the date and time the event occurred. Details of the rst message in the list are
also shown.

Note:  Messages in the log les are removed after thirty days.

5. To view the details of a specic message, select the message on the log.
6. Click X on the upper right of the content pane to close the log viewer.

Service Update Notications  
You can view changes that have been made in this version of the product that may aect you if you are updating from
an earlier version. Two standard reports, Compatibility Exceptions and Deprecated Items, drive the data that display on
the content pane.

The layout for both reports is similar, designed with a split-level display of the content pane. The top portion of the
content pane is scrollable, displaying data that you can search, lter, slice, and export. The boom portion of the
content pane is always visible, displaying data specic to the row you have selected in the top content pane.

• Compatibility exceptions—This report describes changes that may result in dierent behavior or functionality
from previous versions. It also describes which users are aected by the change, its business impact, and the
steps you can take to remedy the eects of the change.

• Deprecations—This report describes items that have been deprecated in this release, the reason for their
deprecation, if replacements are available and what they are, and the migration steps you can take to replace
the functionality that was deprecated.

You can choose to view all service updates data or slice the data to view only the application areas you want to see. You
can also make inline edits to the Status column of each report to help you track how service updates aect your site.

View Service Update Notications  
You can choose to view all service updates data or slice the data to view only the application areas you want to see.

Before you can view service updates data, you must add the Service Update Notications component to the
conguration list for the Conguration buon. See Create a Navigation Set for the Administrator.

1. Click Conguration on the navigation pane.
2. Double-click Service Update Notications in the conguration list.

The Compatibility Exceptions report opens.
3. To view deprecated items, click Deprecated Items on the ribbon.
4. To copy text from any row in the top portion of the content pane, select the text, right-click, and select Copy

Cell to Clipboard.

Service Update Notication Ribbon  
Most of the buons on the service update notications ribbon reect common Oracle Service Cloud functionality and
work the same way as they do in reports.
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In addition to viewing Compatibility Exceptions and Deprecated Items reports, you can search and lter the report data,
dene how you want the data to display on the report, and export data in a variety of formats. You can also edit the
Status column of each report.

Group/Buon Description

Action The buon in this group lets you edit the Status column of the report.

Edit
 

Click this buon to edit the Status column of the displayed report. To edit the status of multiple rows,
 press Ctrl while selecting each record you want to edit at the same time. You can also press Shift to
select multiple consecutive rows.

View The buons in this group let you view and edit records using inline editing.

Compatibility Exceptions Click this buon to display the Compatibility Exceptions report. This report describes changes that may
result in dierent behavior of functionality from previous versions. It also describes which users are
aected by the change, its business impact, and the steps you can take to remedy the eects of the
change.
Compatibility Exceptions is selected by default when you open service update notications.
 

Deprecated Items Click this buon to display the Deprecated Items report. This report describes items that have been
replaced in this release, the reason for the deprecation, if replacements are available and what they are,
 and the migration steps you can take to replace the functionality that was deprecated.

Audit Log Click this buon to view the audit log for the selected row.

Data Set The buons in this group let you search for data in the report, refresh the display, and reset the search
criteria to the report defaults.

Search Click this buon to open the report Search window to select criteria for variables and runtime
selectable lters. See How You Search in Reports.

Refresh Click this buon to reload the data shown using the current search criteria of the report.

Reset Click this buon to reload the data shown using the report default search criteria.

Find Click this buon to open the Find window to enter text, numeric values, or special characters you want
to locate in the report output. Report cells that contain the search value are highlighted on the report.
See Find Content in a Report.

Find Next Click this buon to highlight the next instance of the search values entered on the Find window.

Clear Click this buon to clear the search values entered on the Find window.

Analyze The buons in this group let you sort the data shown on the report and apply auto-ltering, rollups,
and slicing to the data.

Auto Filter Click this buon to enable auto-ltering in the report. Auto-ltering provides column ltering after the
report has been generated. See Enable Auto Filters.

Sort Click this buon to open the Sort window and select which output columns to sort by and the sort
method. See Change Sort Order Using the Ribbon and Change Sort Order Using Column Headers.

Rollups Click this buon to select rollup options and open the Rollups window. See Dene Rollups.

Slice Click this buon to select slice options and open the Slice window. Slicing groups data so you can view
only the subset of records you are interested in. See How You Slice Report Data.

Report The buons in this group let you export the report, forward the report in an email, and save and restore
default seings.
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Group/Buon Description

Export Click this buon to export the data from a report to a le for use with third-party applications. You can
export report data in the following formats: HTML, PDF, Excel, XML, Image, and Delimited. You can also
copy report data to the clipboard. See Export Report and Dashboard Data.
Permission to export, print, and forward reports must be enabled in your prole for this buon to
display. See Analytics Permissions.
 

Forward Click this buon to send the report to individuals or distribution lists in an email. See Forward a Report.
Permission to export, print, and forward reports must be enabled in your prole for this buon to
display. See Analytics Permissions.
 

Default Seings Click this buon and select Save as Default to save your personalized display and data seings for a
report for later use. Select Restore to remove personalized display and data seings from a report and
restore the seings to those dened in the report. See Reset Display and Data Seings.

Print Click the arrow on this buon to access printing options.

Publish Click this buon to save the current report as a read-only snapshot of the current data. The snapshot
will be an exact representation of the current data set, including any display options or customizations.
You will be prompted to name the report and save it to a folder in the Reports tree where it can be
accessed through the Reports explorer. See Overview of the Analytics Explorers.

Compatibility Exceptions  
When changes to this version of Oracle Service Cloud cause changes to existing APIs, the administration interface,
functionality, or how features are congured, these changes are noted as compatibility exceptions.

The Compatibility Exceptions report displays by clicking the Compatibility Exceptions buon on the ribbon. This report
describes the changes, identies who might be impacted by the change, and notes its potential business impact. It also
describes the steps you can take to mitigate the results of the change. The following report columns display on the top
of the content pane.

• Application Area—Area of Oracle Service Cloud aected by the service update.

• Status—Contains a drop-down menu that can be edited inline to designate how a service update has been
addressed. Status options include New, Not Applicable, and User Remediated.

• Aected Items—Lists the application components aected by the service update.

• Release Introduced—Date the service update was added to the product.

The following report rows display on the boom of the content pane specic to the selected row.

• Aected Users—Lists the user types aected by the service update.

• Business Impact—Describes the eect of the service update on business activity.

• Reason for Change—Describes the cause of the required service update.

• Required Changes—Lists the steps required before your site can take advantage of the service update.

• Comments—Captures any additional explanation regarding the service update.

Deprecated Items  
The Deprecated Items report describes items that have been deprecated in this release, the reason for their deprecation,
if replacements are available and what they are, and the migration steps you can take to replace the functionality that
was deprecated.
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When a component or feature has been deprecated, it is usually replaced with newer functionality. Your existing
functionality remains unchanged for two years, so you will not experience problems as a result of deprecation. However,
you should migrate to the new functionality within that time frame.

The deprecation may occur to Oracle Service Cloud functionality or to third-party components used within the Oracle
Service Cloud application, such as PHP features. When replacements are not available, the report contains information
you need to review in order to modify your current functionality to phase out use of the deprecated item.

The Deprecated Items report displays by clicking the Deprecated Items buon on the ribbon. The following report
columns display on the top of the content pane.

• Application Area—Area of Oracle Service Cloud aected by the service update.

• Status—Contains a drop-down menu that can be edited inline to designate how a service update has been
addressed. Status options include New, Not Applicable, and User Remediated.

• Aected Items—Lists the application components aected by the service update.

• Release Announced—Release the deprecation was announced.

• Scheduled Removal—Release the functionality/component is scheduled to be removed.

The following report rows display on the boom of the content pane specic to the selected row.

• Aected Users—Lists the user types aected by the deprecation.

• Business Impact—Describes the eect of the deprecation on business activity.

• Reason for Change—Describes the reason for the deprecation.

• Remediation Steps—Lists the steps required to accommodate the deprecation.

• Comments—Captures any additional explanation regarding the deprecation.

Edit Status Inline  
You can designate how a service update has been addressed by editing the status inline.

1. Do one of the following:

◦ Select the row in the report you want to edit.

◦ Press Ctrl while selecting each row you want to edit at the same time. You can also press Shift to select
multiple consecutive rows.

2. Do one of the following:

◦ Hover over the status until the eld is highlighted in blue, and then click to activate the drop-down menu.

◦ Click Edit on the ribbon to apply edits to multiple rows.

3. Select one of the following options from the drop-down menu.

◦ New—Designates that you still need to address the service update. New is the default option.

◦ Not Applicable—Designates a service update that does not aect your site. For example, there may be a
compatibility exception for Chat, but your site does not use Chat.

◦ User Remediated—Designates that you still need to address the issue or that you have completed the
steps to address the issue. For example, you have either removed the deprecation and it is no longer an
issue, or you have read the compatibility exception, understand the suggested workaround, and have
remediated the issue.

4. Do one of the following:

◦ To apply the edit inline, press Enter or click outside the column you are editing.

◦ Click OK to apply edits to multiple rows.
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Change the Interface Display Name  
You may decide you want to change the name of the interface as it displays for sta members.

Changing the interface name aects only the display of the interface name as it appears to sta members on the agent
desktop. URLs to your interface continue to use the original interface name.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Interfaces.
3. Click the interface name you want to edit.
4. Enter the new interface name in the Display Name text box.
5. Click Save.

Note:  To change the answers report that displays on the Answers page of your customer portal, see
Overview of the Answer and Question Details Pages.

Add or Edit a Currency  
By adding currencies, you can dene the currency associated with each country or province in your knowledge base.

If your organization conducts business outside of the United States, you might need to add foreign currencies to your
knowledge base. You can add multiple currencies and set exchange rates for each. After you create currencies, you can
assign a default currency to each sta account, and your sta members can use them to select the appropriate currency
for contacts, organizations, and forecasts.

Note:  You can add and edit currencies, but you cannot delete them.

1. Click Conguration on the navigation pane.
2. Expand Internationalization, and then double-click Currencies/Exchange Rates.

The content pane displays the Currencies and Exchange Rates trees.
3. To edit a currency, select the currency in the tree and go to step 7.
4. To add a currency, click New and select Currency.

The Installed Cultures list opens.
When you select a culture, the Currency editor automatically populates with the associated culture information
contained in the related region on you workstation. After you select a standard culture and save the currency,
you cannot change the culture association.

The list of installed cultures depends on the regions installed on your workstation and varies based on your
operating system. You can see the list of installed regions by opening Region and Language Options in the
Windows Control Panel. If the matching culture does not appear in the list, you can either add a custom
currency or contact your organization’s information technology team and have the associated language pack
installed on your workstation.

5. To select a standard culture, double-click the culture that matches the currency.
The Currency editor opens.

6. To add a custom culture, double-click Custom Culture at the top of the Installed Cultures list.
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Tip:  If you initially choose to create a custom culture, you can select a standard culture by editing the
currency. This lets you associate a standard culture with the currency if the standard culture becomes
available on your workstation.

7. Enter eld information.

Field Description

Names and Symbols

Label
 

Enter the name of the currency as it appears in the Currencies tree.
 

English Name
 

Enter the English name of the currency.
 

Native Name
 

Enter the name of the currency as it appears in the associated country.
 

Symbol
 

Enter the symbol that represents the currency you are adding. For example, the symbol
for the United States dollar is $.
 
You may need to use your operating system character-mapping feature to determine
the keystrokes for entering symbols that do not appear on your keyboard.
 

Code
 

Enter three leers to represent the currency. For example, USD is the currency code for
the United States dollar.
 

Use Code
 

Select this check box to use the three-leer currency code instead of the symbol to
represent the currency.
 

Currency Formats

Decimal (Dec.) Precision
 

Click this drop-down menu to select decimal precision, which denes the number of
digits displayed after the decimal symbol. For example, the decimal for the United States
dollar is two decimal places ($123.44).
 

Decimal (Dec.) Separator
 

Enter a symbol to represent the decimal place. For example, the decimal separator for
the United States dollar is a period ($678.99).
 

Digit Grouping
 

Click this drop-down menu to select a digit-grouping format.
 

Group Separator
 

Enter the symbol used to separate digit groups. For example, the digit grouping
separator for the United States dollar is a comma ($1,234,567.99).
 

Positive Format Select a format to represent positive currency.
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Field Description

   

Negative Format
 

Select a format to represent negative currency.
 

Examples

Positive Example
 

Enter the number you want used in the positive currency example.
 

Negative Example
 

Enter the number you want used in the negative currency example.
 

Interface Visibility

Label
 

Enter the currency label as you want it to appear on each interface.
 

Visible
 

Select the check box for each interface where you want the currency to appear.
 

8. Click Save.

Add or Edit Exchange Rates  
After you add currencies, you can add and edit exchange rates.

Currencies must be created before adding exchange rates. See Add or Edit a Currency.

If your organization conducts business outside of the United States, you might need to add foreign currencies to
your knowledge base. You can add multiple currencies and set exchange rates for each. Keeping currencies and the
associated exchange rates up-to-date helps your sales representatives provide the most accurate quotes for customers.

1. Click Conguration on the navigation pane.
2. Expand Internationalization, and then double-click Currencies/Exchange Rates.

The content pane displays the Currencies and Exchange Rates trees.
3. Do one of the following:

◦ To add exchange rates, click New and select Exchange Rate.

◦ To edit exchange rates, click the date in the tree.

The Exchange Rate editor opens.
4. Enter eld information.

Field Description

Start Date The Start Date becomes the name of the exchange rate in the tree. Enter the date that
the exchange rates take eect or click the drop-down calendar and select a start date.
The start date can be a past date but not a future date.
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Field Description

Rates Enter exchange rates in this table. The number in the table cell is the multiplier used to
convert the currency in the rst column to the currency in the corresponding column.

5. Click Save.
As shown in this image, one U.S. dollar (USD) is equivalent to 1.10154 Canadian dollars (CAD), 5.94126 Croatian kunas
(HRK), 0.78517 euro (EUR), and 0.96471 Australian dollars (AUD). Similarly, to convert other currency to U.S. dollars,
multiply the number of Canadian dollars by 0.98406, the number of Croatian kunas by 0.16833, the number of euros by
1.27264, and the number of Australian dollars by 1.03650.

Screen Pops  
Screen pop functionality lets you communicate with Oracle Service Cloud from a third-party program to submit a screen
pop request.

For instance, you can open, or “pop,” a report or an editor as a new content pane tab on the Service Console by sending
a request from a third-party application. When you pop an editor, you can view and edit records from the new window.
When you pop a report, you can pass runtime lter values to the report and perform all normal report functions.

Note:  Before you can integrate the screen pop feature with an external program, it must be enabled and
congured. Contact your Oracle account manager.

How You Congure Third-Party Software for Screen Pops  
After screen pop has been enabled and congured, you must congure your third-party software to submit an HTTP
GET in the proper format. You can generate the screen pop request URL by scripting Microsoft.XMLHTTP, Internet
Explorer, or any other HTTP-aware controls or languages.

HTTP GET is the only supported method. All others will return a 403 Forbidden error message. In addition, a request
from a computer other than the localhost will also return a 403 Forbidden error message. If HTTP GET is used from the
localhost, Oracle Service Cloud will return a status code of 200 OK, 403 Forbidden, or 404 Not Found.

Note:  The sta member making the screen pop request must be logged in to Oracle Service Cloud at the time
of the request.

Following is an example of a URL for a screen pop request.

hp://localhost:<port>/screenpop?param1=value1&param2=value2
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The port variable is populated with the value specied in the EXT_CONSOLE_WS_PORT conguration seing located in
RightNow Common/Screen Pop/General.

Tip:  You can override the EXT_CONSOLE_WS_PORT value for individual sta members by updating the
External Screen Pop Port eld on the Sta Accounts editor.

Enter screen pop function parameters and associated values.

Parameter Description

t
 

Species the type of screen pop, either editor (t=editor) or report (t=report). The editor screen pop
opens a record editor of the type specied by the recordType variable. The report screen pop opens the
report specied by the id variable.
 

recordType
 

Species which editor is displayed when the console is popped.
 
1—Incident
 
2—Answer
 
4—Opportunity
 
5—Contact
 
6—Organization
 
7—Task
 
17—Campaign (requires owID=<int>)
 

id
 

Species the ID of the record (when used with t=editor) or the report ac_id (when used with t=report) to
open.
 

Note:  When opening an editor, a new record also opens if no ID is supplied.

<runtime lter name>
 

This parameter is used with the t=report parameter to specify the value of a runtime-selectable lter
in the specied report. This parameter should be the lter name of a runtime lter you want to use
to select data. The value should be the string you want to search on. For example, contacts.last_
name=Jones or opportunites.assgn_acct_id=12.
 

The following URL is an example of an editor screen pop that opens a contact record with the contact_id of 23.

hp://localhost:57575/screenpop?t=editor&recordType=5&id=23

The following URL is an example of a report screen pop that opens the Agent Activity report using the runtime lter
accounts.display_name with the value Abby Parker.

hp://localhost:101/screenpop?t=report&id=55&accounts.display_name=Abby%20Parker

307



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Related Topics
• Add or Edit a Sta Account

Email Management  

Overview of Email Management  
Communicating clearly and promptly through email is essential to providing great customer experiences. Handling high
volumes of email eciently requires you to give careful thought to important topics such as process, automation, and
security.

With Oracle Service Cloud, you can achieve high quality and eciency in all of your service and marketing
communication. Whether responding to service questions or broadcasting mailings and surveys to large audiences, the
email management features give you complete control over the handling of inbound and outbound email messages.

How Email Works in Service  
Oracle RightNow Cloud Service (Service) email management system is a exible solution for handling email
communication between your customers and your customer service team.

The system evaluates each incoming email to ensure it meets your criteria for service, and then manages all back-and-
forth email replies between the agent and contact until the incident is resolved. Along the way, Oracle Service Cloud can
automate key service functions to help your team deliver timely, world-class service.

Note:  A set of system-generated administrator notications, administrator emails, and contact emails
are sent to sta and contacts to support activities and events occurring throughout the system. Message
templates let you quickly apply your organization’s brand across all notications and emails. You can also
customize your messages, including the message content, enabling and disabling specic notications and
emails, and dening the message format as HTML or text. For complete details and procedures about working
with the Message Templates editor, see Overview of Message Templates.

This owchart shows how incoming customer email messages are handled in Service.
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When a customer emails a question to your customer support email account, Service handles it using the following
email management process.

1. A contact record is associated—The Techmail utility rst searches all contact records for the email address in
the Reply To eld of the mail header in the message. If no match is found, Techmail looks for the address in the
mail header From eld. If no match is found in the From eld, Techmail looks in the Sender eld. If a match is
found, the contact record is associated with the incoming request. If the customer’s email address is not found
in an existing contact record, a new contact record is created for the customer.

By default, the incoming email processing order comes from the mail header elds in this order: Reply To, From,
Sender. However, if the business policies of your organization restrict use of the Reply To mail header, you can
change the processing order to use the From mail header by seing the EGW_CONT_ASSOC conguration
seing to 1 in the Conguration Seings editor. See Edit a Conguration Seing.
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Also by default, an email address cannot be shared by multiple contact records. However, when email address
sharing is enabled and an email is received from an address shared by two or more contacts, Techmail invokes
a contact-matching process to associate the contact. See Email Address Sharing.

2. Contact validity is veried—After the email management system identies a matching contact record,
customer information is evaluated to determine whether it meets your organization’s requirements for service.
If SLAs are required, the system checks to ensure the customer has a valid SLA before creating an incident.
If the customer does not have a valid SLA, an auto-response denying assistance is generated and sent to the
customer. See Overview of Service Level Agreements.

3. An incident is created—Once a contact record is matched and any SLA requirements are met, Techmail creates
an incident using the contents of the email message. If the message is multipart (a common MIME type
containing both HTML and text versions of the same message), the text version of the message is added to the
incident thread and the HTML version is discarded. If the message contains HTML only, it is converted to text
and added to the thread.

4. The incident is processed by business rules—Upon incident creation, Oracle Service Cloud sends the contact
an auto-generated receipt for the question. However, business rules are often congured to perform additional
functions such as assigning an SLA, sending an auto-response, and assigning the incident to an agent for
a response. Rules can also be congured to escalate the incident if the assigned agent does not answer the
customer’s question within a specied time period. See Overview of Business Rules.

5. The agent responds—When an agent responds to the contact’s question, an email is sent to the contact
containing the agent response. Occasionally, a contact may reply with additional questions or information for
the agent. Techmail identies the reply message by looking for specic markers (such as the contact email
address, the reference number in the subject line, and the message tracking string in the mail header) and
applies the update to the incident, extending the conversation until resolved. See Email Reply Processing and
Cross-Site Email Management.

To further complement the email management process described here, additional options are available for customizing
the process to meet unique business needs. For descriptions of these seings, see Advanced Conguration for Email
Handling.

Related Topics
• Best Practices for Sending Email

Email Reply Processing  
Service lets customers update incidents by replying to email messages. However, sometimes customers include the
original message in their reply, quoting back the email they received. There are several ways that the Techmail utility can
manage this scenario.

When the Techmail utility detects an email reply, it aempts to identify the part of the message containing the
customer’s reply, and strips out any text that may have been quoted back from the original message thread. In this
way, new replies are added to the incident as a new entry in the incident thread, while text from previous thread entries
is ignored. Techmail uses several methods to determine which blocks of text in a message consist of previous thread
entries.

Most email clients mark or “block quote” the original message when replying. In text messages, the original text is often
block quoted by inserting a greater than symbol (>) or a vertical bar (|) at the beginning of each line of the original text.
In HTML messages, the original message is usually enclosed in block quote HTML tags (<blockquote>). Parameters in
the block quote HTML tag indicate how the message should be displayed (for example, each line begins with a vertical
bar or an indent). The Techmail utility block-quoted reply detection method nds block-quoted text and removes it from
the email, leaving only the reply from the customer.
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Tip:  You can dene additional characters besides > and | as block-quoted text indicators in the
EGW_QUOTE_CHARS conguration seing. See Advanced Conguration for Email Handling.

If you enable EGW_REPLY_BETWEEN_ENABLED and select the Force Reply Between Lines check box, Techmail can
easily separate the reply from the original email text, as customers are directed to compose their reply between two
distinct line markers. If you enable the conguration seing but do not select Force Reply Between Lines on the
Incoming Email seings of the mailbox, Techmail rst checks for a reply between the lines. If it does not nd text
between the markers, it looks for the > or | block-quoted text indicators or block quote HTML tags. In addition, when the
Force Reply Between Lines check box is not selected, the system inserts checksum code at the boom of the email so
that the reply part of the email can be identied.

Tip:  The EGW_CHECKSUM_STYLE conguration seing denes the style that is applied to the checksum
code. To make the checksum code font blend with the background color of your email, you can change the
style and text formaing by editing this seing through the Conguration Seings editor. See How You
Customize Conguration Seings.

If a customer replies to multiple points within the original email, intermixing the reply with the original text, the message
may contain multiple blocks of quoted text. In this case, the replies may refer to the original text above them, which may
be important, so Techmail includes the entire email message in the incident.

If a customer replies within the original text, and the reply text begins with a block quote, such that the reply is
indistinguishable from the original text, Techmail can determine that additional text has been added within the original
text by comparing checksums in the reply to checksums in the original message. If the checksums dier, the entire
email is added to the incident to ensure that no reply text is lost.

Techmail can also detect and remove “boilerplate” messaging while leaving the customer’s content intact. Boilerplate
messaging is text that has been added to an email message by a mail client, such as a line of embedded advertising
text. This helps to ensure that the thread is not diluted with advertising and contains only information pertinent to the
discussion.

Related Topics
• How Email Works in Service

Single-Send Email Response Logic  
If a contact is associated with multiple email addresses, service responses are sent to all associated addresses by
default.

This means that if an incident contact has a primary email address and two alternate email addresses, every time
an incident response is sent to that contact, it is sent to all three email addresses. You can limit your responses to be
sent to a single email address by enabling the site-wide conguration seing OE_SVC_SENDMAIL_SINGLE_ADDRESS
(Common/General/Outgoing Email).

After enabling the conguration seing, service responses are sent only to the specied email address and agents can
select which one of the contact email addresses they want to send the response to from the incident workspace. See
Advanced Conguration for Email Handling. That email address value remains for the life of the incident. However, any
new incidents for that contact will default to the primary email address. See How You Send Incident Responses.
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The default value for a response sent from the incident workspace is the primary email address. However, if the incident
is created from the customer portal or a chat session (when no login is required), or by the Techmail utility, the value is
set to the email address the request was sent from. Following are examples using these cases.

• Customer portal (when no login is required)—If the email address is available on the Ask A Question page and
matches an alternate address of a contact, the alternate address is used as the response address.

• Chat (when no login is required)—If the email address is available on the Chat page and matches an alternate
address of a contact, the alternate email address is used as the response address.

• Techmail—If incoming incidents are processed by Techmail, it evaluates the email address for a match from the
contact record and uses the matching address as the response address.

Related Topics
• How Email Works in Service

Cross-Site Email Management  
Service automatically handles email between separate Oracle Service Cloud sites and the site-specic incidents are
accurately updated on each site even if unique reference numbers are used for the same incident. Therefore, you can be
condent that when emails pass between sites, all incident information will be current and accurate.

For instance, suppose your organization has an airline division and a hotel division, each with its own site. Now suppose
that an incident was created from the airline site about a hotel issue. An incident response is sent to the hotel site and,
when processed, the incident is assigned a reference number that is appropriate for that site—a dierent number from
the airline site reference number. An agent on the hotel site responds to the incident. In the meantime, an agent on the
airline site has new information that she adds to the original incident. The system recognizes the relationship between
the two incidents and both are updated appropriately on their respective sites. See Overview of Incidents.

Related Topics
• How Email Works in Service

How Email Works in Outreach and Feedback  
Oracle RightNow Outreach Cloud Service (Outreach) and Oracle RightNow Feedback Cloud Service (Feedback) provide
an ecient system for handling all email communication related to mailings and surveys, including proofs, market tests,
and delivery error notications.

This owchart shows the general sequence of email communication supported by this process.
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As the owchart illustrates, the process of sending mailings and surveys includes a number of points where outgoing
and incoming email communication can occur.

• Message proong—Once a mailing or survey is designed, sta can send one or more proof versions to the
necessary contacts and sta members for feedback and approval.

• Market testing—This option lets sta send small batches of a mailing or survey in advance to a subset of
the audience to test dierent designs and messaging. They can then review the results before selecting and
sending the nal version.

• Message delivery—Once proofs have been approved and market testing is complete, the mailing or survey can
be sent or scheduled for delivery to the remaining audience.

• Customer reply—A customer who receives a mailing or survey may aempt to reply to it by email. The Techmail
utility can process these replies and convert them to incidents.

• Delivery error notication—In the event that a mailing or survey is sent to an address that is invalid or is
experiencing technical issues, the recipient mail server may return a delivery error or “bounce” notication in
the form of an email sent to the Envelope From/Bounce Address dened in your outgoing email seings. See
Edit an Oracle-Managed Service Mailbox. The Techmail utility can process most delivery errors and address
them appropriately, as described in Email Bounce Handling.

313



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Unless the From and Reply To elds are customized within a mailing or survey, the system uses the addresses dened
in the default mailbox for all proofs, market tests, and production mailings and surveys. Specically, if the optional eld,
Friendly From/Branded Address is dened, then that address displays as the From address in delivered email. However,
if only the Envelope From/Bounce Address is dened, and Friendly From/Branded Address is blank, then the address in
Envelope From/Bounce Address is used. Mailbox seings are accessed from the navigation pane ( Conguration > Site
Conguration > Mailboxes ). See Edit an Oracle-Managed Service Mailbox.

This email management process applies to most basic Outreach and Feedback implementations. However, additional
options exist for customizing the process to meet your organization’s unique needs. See Advanced Conguration for
Email Handling for descriptions of these additional options.

How Mailboxes Work  
Mailboxes are used to dene outgoing email seings and to specify the email accounts to pull email messages from.
You cannot send or receive email in Oracle Service Cloud until at least one mailbox is congured and enabled for the
interface you are using.

There are two types of mailboxes that can be used with Service—Oracle-managed Service mailboxes, the recommended
type, and Service mailboxes, also referred to as general Service mailboxes. Oracle-managed Service mailboxes and
general Service mailboxes are used only with the Service application, while Outreach mailboxes are used with either
Outreach or Feedback.

You can congure mailboxes to handle only outgoing email, only incoming email, or both. You can also dene security
seings for your mailboxes.

• Outgoing email seings dene the identifying information to be included in outgoing email sent by the
mailbox, such as the Envelope From/Bounce Address, Friendly From/Branded Address, Reply-To Address, and
Display Name.

• Incoming email seings dene the POP server, POP account, and password used to access incoming email.
Other incoming seings provide methods to lter mail messages (by applying discard lters and restricting le
aachments by size and le type) and forward rejected messages to another email address.

Note:  If you use Oracle-managed Service mailboxes, the Incoming Email Enable check box and the POP
Server, POP Account, and Password elds on the Incoming Email page are read-only elds because they have
already been dened by Oracle.

• Security seings can be used to enable SSL and S/MIME authentication for your email. See Email Security
Features.

Note:  To enable processing of bounce errors in Outreach or Feedback, the Envelope From/Bounce Address
in your Outreach mailbox outgoing email seings must use the POP server and the POP account dened in
the incoming seings. For example, if the POP server is mail.rnmk.com and the POP account is globalsupport,
then the Envelope From/Bounce Address needs to be dened as globalsupport@mail.rnmk.com. See Email
Bounce Handling.

Related Topics
• Best Practices for Using Branded Email Domains
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Edit an Oracle-Managed Service Mailbox  
We recommend using Oracle-managed Service mailboxes because of several inherent advantages, including easy setup,
faster and more reliable email processing, and reliability.

Oracle-managed Service mailboxes are mailboxes that Oracle initially congures for you by dening crucial incoming
email seings. You can customize Oracle-managed Service mailbox seings that let you brand your mailbox, but
seings that control the essential functions of incoming email processing are read-only. This eliminates any risk of
those seings being miscongured. Because Oracle handles these seings for you, you can be certain that your mailbox
has been set up correctly. Oracle-managed Service mailboxes give you the following benets.

• Easy setup—Oracle congures crucial incoming email seings for you, such as enabling incoming email and
dening your Pop Server, POP Account, and Password elds.

• Faster and more reliable email processing—Techmail  has been designed to handle large volumes of messages
through parallel message processing, which ultimately enables your sta to respond to incidents faster.

• Reliability—Oracle monitors Oracle-managed Service mailboxes twenty-four hours a day, seven days a week.

Note:  This procedure assumes that Oracle has already added an Oracle-managed Service mailbox for you.
Oracle-managed Service mailboxes can be added from the Oracle Service Cloud Conguration Assistant. For
information on accessing the Conguration Assistant, see  Answer ID 6354 .

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Mailboxes. The Mailboxes tree displays on the content pane

with the primary interface expanded to display your existing mailboxes.
a. To edit Oracle-managed Service mailboxes on additional interfaces, expand the additional interface for

which you want to edit a mailbox.
3. Select an Oracle-managed Service mailbox in the tree.

The outgoing email seings display on the editor.
Oracle-managed Service mailboxes display only if one (or more) has been added to your site. Oracle-managed
Service mailboxes can be added from the Oracle Service Cloud Conguration Assistant. For information on
accessing the Conguration Assistant, see  Answer ID 6354 .

4. Enter the following eld information to enable mailbox functionality.

Note:  For Oracle-managed Service mailboxes, the Incoming Email Enable eld is read-only. However,
this eld can be edited from the Oracle Service Cloud Conguration Assistant. For information on
accessing the Conguration Assistant, see  Answer ID 6354 .

Field/Buon Description

*Name
 

Enter the mailbox name in this eld.
 
For Oracle-managed Service mailboxes, this eld, which can be edited, is set to the
name that was designated when Oracle initially added the mailbox to your site.
 

Outgoing Email Enable
 

Select this check box to enable the mailbox to send outgoing email. When this check
box is cleared, the mailbox cannot send outgoing email and agents cannot respond to
incidents associated with this mailbox. The default is enabled.
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Field/Buon Description

Incoming Email Enable
 

Select this check box to enable the mailbox to receive incoming email. The default is
enabled.
 
For Oracle-managed Service mailboxes, this check box has been selected for you and is
read-only.
 

Default
 

Select this check box to set this mailbox as the default mailbox for the interface. You
must designate one mailbox as the default. For Service mailboxes, after designating
this mailbox as the default Service mailbox, the mailbox name will then display in the
Mailbox eld on the Details tab of the agent’s incident workspace. This lets your agents
easily associate incidents with the correct mailbox when responding to customers. See
Add Incident Information on the Details Tab.
 

Note:  This check box is selected by default for general Service and Outreach
mailboxes, but not for Oracle-managed Service mailboxes. When the Default
check box is selected, it becomes disabled and cannot be cleared. You must
set another mailbox as the default, and then save your changes in order to
clear this check box.

5. Enter the following eld information to congure outgoing email for this mailbox.

Field Description

*Envelope From/Bounce Address
 

Enter the email address that is used as the return path for bounced emails. (For Oracle-
managed Service mailboxes, this eld is set to the email address that was designated
when Oracle initially added the mailbox to your site.) The value in this eld displays as
the From address in the outgoing email unless the Friendly From/Branded Address eld
is dened. See Email Bounce Handling.
 

Tip:  To ensure that your bounced emails process correctly, we recommend
using the email address provided when your account was set up. For
example, a typical Oracle-managed Service or general Service mailbox would
be “example@mail.custhelp.com.” A typical Outreach mailbox would be
“example@mail.rnmk.com.”

Friendly From/ Branded Address
 

Use this optional eld to brand your email message. If you use this eld, this is the email
address your recipients will see in the email you send. For example, if you want the
email address that displays to your recipients to be dierent from the email address
dened in the Envelope From/Bounce Address, enter the address the way you want it to
appear in this eld.
 
If you dene an email address in this eld, it displays as the From address in the
outgoing email.
 

316



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

Reply-To Address
 

Typically, the reply-to address is the same as the address specied in the Envelope
From/Bounce Address eld, but you can use this optional eld if you want customers
to send their responses to a dierent email address. (For Oracle-managed Service
mailboxes, this eld is set to the email address that was designated when Oracle initially
added the mailbox to your site.) The Reply-To Address eld must contain a valid email
address in order to receive messages. If the Reply-To Address eld is not dened, then
either the Envelope From/Bounce Address or the Friendly From/Branded Address is
used as the default email address.
 

CAUTION:  If you use incidents, the Reply-To Address must match the
Envelope From/Bounce Address unless your own mail administrator has set
up SMTP forwarding for this address to automatically forward to the Envelope
From/Bounce Address. See  Answer ID 1272 .

Display Name
 

Enter the name you want to appear on outgoing messages as the sender. For example,
 Global Wireless Customer Service.
 

6. To enter incoming email information, click Incoming Email on the ribbon.
The incoming email seings display on the editor.

7. Enter the following eld information to congure incoming email for this mailbox.

Note:  For Oracle-managed Service mailboxes, the POP Server, POP Account, and Password elds are
read-only. However, this eld can be edited from the Oracle Service Cloud Conguration Assistant. For
information on accessing the Conguration Assistant, see  Answer ID 6354 .

Field Description

*POP Server
 

Enter the address or IP address of the POP server. For example, the POP server for
jsmith@mail.custhelp.com would be “mail.custhelp.com.”
 
For Oracle-managed Service mailboxes, this eld has been set up for you and is read-
only.
 

Note:  To ensure that your bounced emails and replies process correctly, you
must use the POP server conguration provided when your account was set
up.

*POP Account
 

Enter the account name of the mailbox. For example, the account name for
jsmith@mail.custhelp.com would be “jsmith.”
 
For Oracle-managed Service mailboxes, this eld has been set up for you and is read-
only.
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Field Description

Note:  To ensure that your bounced emails and replies process correctly, you
must use the POP account conguration provided when your account was set
up.

Password
 

Enter the password of the mailbox.
 
For Oracle-managed Service mailboxes, this eld has been set up for you and is read-
only.
 

Send Rejected Messages To
 

Enter an email address to send all rejected messages to, including all bounced and
returned messages and automatic responses. This can help you determine why a
message has been rejected so you can take action to resolve the issue if necessary.
 

Discard Automatic Responses
 

Select an option from this drop-down menu to determine the level of automatic
response ltering.
 
You can dene the levels of automatic response ltering by seing values for the
following conguration seings:

◦ EGW_AR_CONS_BODY_FLTR

◦ EGW_AR_MODR_BODY_FLTR

◦ EGW_AR_AGGR_BODY_FLTR

 
Default values are blank. See How You Customize Conguration Seings.
 

O
 

Select this option to turn o automatic response ltering. All automatic responses
received by the mailbox are turned into incidents.
 

Conservative
 

Select this option to activate conservative response ltering.
 
The value of “conservative” is dened by the value of the conguration seing EGW_
AR_CONS_BODY_FLTR. Default is blank.
 

Moderate
 

Select this option to activate moderate response ltering.
 
The value of “moderate” is dened by the value of the conguration seing EGW_AR_
MODR_BODY_FLTR. Default is blank.
 

Aggressive
 

Select this option to activate aggressive response ltering.
 
The value of “aggressive” is dened by the value of the conguration seing EGW_AR_
AGGR_BODY_FLTR. Default is blank.
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Field Description

Message Pull Limit
 

Enter the maximum number of email messages to pull from the mailbox during a
Techmail run. The remaining messages are left on the POP server until the next time
Techmail runs. The default pull limit is 5,000 messages.
 
Messages that are ltered are not counted toward this limit. Only emails that create
incidents are counted. For example, if Message Pull Limit is set to 100 and the mailbox
contains 200 messages, but 50 of them are ltered by rules, Techmail pulls 100 of the
remaining messages from the mailbox and leaves 50 for future processing.
 

Max Aachment Size
 

Enter the maximum size, in number of bytes, allowed for le aachments.
 
The default maximum size is 5,000,000 bytes (5MB).
 

Tip:  Because this feature is designed to support incident-based work
processes and is not intended to serve as a large format le repository, we
recommend keeping this value low. While there is no upper limit to the value
you may specify, several external factors determine the actual size limitation
of les that may be received. See  Answer ID 280  on our support site.

Maximum Description Size
 

Enter the maximum size, in bytes, allowed for the incident description. If an email
exceeds this limit, it is added to the incident as a le aachment and a small thread
entry refers agents to the aached le. The default value is 250,000.
 

Force Reply Between Lines
 

Select this check box to require that customers enter their reply between the two line
markers included in an incident response email. When customers reply between these
lines, Techmail separates their reply from the quoted response text and adds it as a new
thread.
 

◦ If this check box is selected and customers do not reply between the lines, an
incident thread is not created from their reply. Another email is sent automatically
to request that they reply between the lines.

◦ If this check box is not selected and customers do not reply between the lines,
Techmail looks for block-quoted text indicators to nd the customer’s reply.

See Email Reply Processing.
 

Delete Bulk Messages
 

Clear this check box to turn bulk messages into incidents. By default, this box is selected
to delete bulk email. An email is considered bulk when the Precedence: header is set to
bulk, junk, or list.
 

Delete Returned Messages
 

Clear this check box to turn returned messages into incidents. By default, this check
box is selected to delete returned email. An email is considered to be returned when
the From address begins with postmaster or mailer_daemon, or if the MIME type is
Multipart/Report.
 
This option is not available for Outreach mailboxes.

319

https://cx.rightnow.com/app/answers/detail/a_id/280/


Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

 

Note:  The EGW_SECURE_UPDATE_MODE conguration seing aects the
handling of returned messages.

Discard Filters
 

Select from any of the following lters to discard all incoming email with the specied
characteristics.
 

CAUTION:  To prevent unintended behavior, do not add hard returns to create
blank lines within any of the discard lters.

Addresses
 

Enter the email addresses you do not want to receive email from. Separate entries in
the list with commas. (Do not add hard returns within this lter.) An asterisk (*) may
be used as a wildcard to match any characters. For example, to discard all email from
jsmith@example.com and all example.org addresses, enter:
 
jsmith@example.com,*@example.org
 

Headers
 

Click this tab and enter any strings found in any header that identies email you want to
discard. Enter each entry on a separate line using up to 4,000 characters. (Do not add
hard returns within this lter.) The text comparison is not case sensitive. For example, to
discard all email with any header line referencing a specic IP address or any email with
the custom header of X-BulkPrecedence, enter:
 
[124.456.789.321]
 
X-BulkPrecedence:
 

Subject
 

Click this tab and enter any text found in an email subject line that identies email you
want to discard. Enter each entry on a separate line. (Do not add hard returns within this
lter.) The text comparison is not case sensitive. For example, to discard all email with
the following text in the subject line, enter:
 
Mortgage rates
 
Marketing solution
 
Bargain alert
 

Body
 

Click this tab and enter any text found in an email body that identies email you want to
discard. Enter each entry on a separate line using up to 4,000 characters. (Do not add
hard returns within this lter.) The text comparison is not case sensitive. For example, to
discard all email with the following text in the body, enter:
 
Be your own boss
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Field Description

 
If you do not wish to receive further mailings
 
To unsubscribe
 

MIME Type
 

Click this tab and enter a list of aachment types you will not accept in MIME format
(type/subtype). The major MIME types are application, audio, image, message, model,
 multipart, text, and video. Separate entries in the list with commas or new lines. (Do not
add hard returns within this lter.) An asterisk (*) can be used as a wildcard to match any
characters. For example, to exclude MPEG video aachments, GIF images, and all audio
formats, enter:
 
video/mpeg, image/gif, audio/*
 
This lter blocks only matching le aachments. The remaining contents of the email
continue to process.
 

File Types
 

Click this tab and enter a list of aachment types you will not accept based on the le
name extension. Separate entries in the list with commas or new lines. (Do not add hard
returns within this lter.) Specic le names can be specied, or an asterisk (*) can be
used as a wildcard to match any characters. For example, to exclude all executable les,
 screen savers, and any script titled worm.vbs, enter:
 
*.exe, *.scr, worm.vbs
 
This lter blocks only matching le aachments. The remaining contents of the email
continue to process.
 

8. To enter security seings, click Security on the ribbon and see Email Security Features.
9. To view the mailbox conguration audit log, click Audit Log on the ribbon.

10. Click Save.

Add or Edit a General Service Mailbox  
General Service mailboxes are not managed by Oracle. Therefore, you handle the entire mailbox setup yourself. If
you decide to use general Service mailboxes, keep in mind that your mailbox will not be monitored by Oracle and
advantages that are inherent to Oracle-managed Service mailboxes will not be available.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Mailboxes. The Mailboxes tree displays on the content pane

with the primary interface expanded to display any existing mailboxes.
a. To add or edit Service mailboxes on additional interfaces, expand the additional interface for which you

want to add or edit a mailbox.
3. Do one of the following:

◦ Click New on the ribbon and select New Service Mailbox.

◦ To edit a mailbox, select it in the tree.

The outgoing email seings display on the editor.
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Note:  General Service mailboxes are not managed by Oracle.

4. Enter eld information described in the Mailboxes Editor table to enable mailbox functionality.
5. To congure outgoing email for this mailbox, enter eld information described in the Outgoing Email Seings

table.
6. To congure incoming email for this mailbox, click Incoming Email on the ribbon and enter eld information

described in the Incoming Email Seings table.
7. To enter security seings, click Security on the ribbon and see Email Security Features.
8. To view the mailbox conguration audit log, click Audit Log on the ribbon.
9. Click Save.

Add or Edit an Outreach Mailbox  
If you use Outreach or Feedback on your site, you also need to add an Outreach mailbox.

Note:  To ensure accurate processing of replies, inbound messages, and bounces, Outreach mailboxes
cannot be shared with either type of Service mailbox. Techmail handles messages in Oracle-managed Service
mailboxes and general Service mailboxes dierently from how it handles them in Outreach mailboxes. For this
reason, you must set up one mailbox for Service and a separate mailbox for Outreach and Feedback.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Mailboxes. The Mailboxes tree displays on the content pane

with the primary interface expanded to display any existing mailboxes.
a. To add or edit Outreach mailboxes on additional interfaces, expand the additional interface for which you

want to add or edit a mailbox.
3. Do one of the following:

◦ Click New on the ribbon and select New Outreach Mailbox.

◦ To edit a mailbox, select it in the tree.

The outgoing email seings display on the editor.

4. Enter eld information described in the Mailboxes Editor table to enable mailbox functionality.
5. To congure outgoing email for this mailbox, enter eld information described in the Outgoing Email Seings

table.
6. To congure incoming email for this mailbox, click Incoming Email on the ribbon and enter eld information

described in the Incoming Email Seings table.
7. To enter security seings, click Security on the ribbon and see Email Security Features.
8. To view the mailbox conguration audit log, click Audit Log on the ribbon.
9. Click Save.

How You Designate a Default Mailbox  
The default mailbox is the mailbox that is used to send Service incident responses. You must designate one default
mailbox for Service—either an Oracle-managed Service mailbox or a general Service mailbox.

After designating a default Service mailbox, the mailbox name will then display in the Mailbox eld on the Details
tab of the agent’s incident workspace. This lets your agents easily associate incidents with the correct mailbox when
responding to customers. See Add Incident Information on the Details Tab.

Note:  If you do not designate a default mailbox by selecting the Default check box, agents must manually
select a mailbox each time they respond to an incident.
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The default mailbox is designated by the Default check box on the Outgoing Email page of the editor. After the default
mailbox is set, a green check mark displays on top of the mailbox icon in the tree. This check box is selected by default
for general Service and Outreach mailboxes, but not for Oracle-managed Service mailboxes. Therefore, if your Oracle-
managed Service mailbox is the only Service mailbox you have, you must designate it as the default mailbox by
selecting the Default check box.

Note:  If you communicate with your customers through mailings and campaigns and survey your customers
and prospects, you must also designate a default Outreach mailbox.

Related Topics
• Seing the Default Mailbox (video)

Email Security Features  
Oracle Service Cloud provides security and privacy options for all incoming and outgoing email. Using accepted
industry standards, the email security features help protect your communication in three important ways.

• Authentication assures the message recipient that the sender is who it appears to be and that no other parties
are misrepresenting themselves as the sender.

• Message integrity ensures that the content of the message has not been deliberately or accidentally changed
during transmission.

• Privacy ensures that the message is not readable by anyone other than the intended recipient.

To safeguard your email communication, Oracle Service Cloud supports SSL and S/MIME security methods along
with the ability to manage certicates and authentication options. Together, these features can provide a high level of
security for messages traversing the Internet between you and your customers.

Security conguration is an important part of your Oracle Service Cloud application and we realize that your
organization may have unique security needs. For an in-depth discussion about security practices in Oracle Service
Cloud and how to protect your data, see Overview of Oracle Service Cloud Security and Compliance.

Congure SSL Security Seings  
SSL (secure sockets layer) protocol is the industry standard for securing Internet-based data transfer. SSL encrypts the
data stream during transmission to prevent the exposure of sensitive information, such as passwords, to unauthorized
parties.

Servers with SSL capability have been issued a public certicate and a private key by a certication authority. When
a client (such as Techmail) communicates with an SSL-enabled server, the server sends the client its public certicate
for verication. After the certicate has been validated to be current and signed by a trusted certication authority,
the communication channel between the client and server is encrypted and can then be used to securely exchange
information. The information remains encrypted as it travels between the two parties and is secure until the server or
client decrypts it at the other end.

If you are hosting a POP mail account on your own mail server, conguring an SSL connection between the Techmail
utility and the mail server protects the security of email messages as they are processed.

Note:  SSL is not used for accessing POP accounts hosted by Oracle because the mail server and Techmail
utility reside within the same secure network.
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SSL seings let you specify the method used to establish the secure connection and set conditions on how strictly
Techmail validates the server SSL certicate before connecting.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Mailboxes.

The Mailboxes tree displays on the content pane.
3. Click the mailbox you want to edit in the tree.
4. Click Security on the ribbon.

The mailbox security seings display on the content pane.
5. Enter eld information to select the SSL method and set certicate verication requirements.

Field Description

SSL Method
 

Click this drop-down menu to select an SSL option that determines how Techmail
retrieves messages from the mailbox.
 

Disabled
 

Select this option to use regular POP3 (on port 110) without SSL encryption. This is the
default seing.
 

Note:  The check boxes for accepting SSL certicates are grayed out if you
select Disabled for the SSL method.

Using POP3 SSL port
 

Select this option to use POP3 with SSL encryption on port 995.
 

Using STLS command
 

Select this option to use the standard POP3 port (port 110) with SSL encryption. After
the server greeting, the “Start TLS” command is used to switch to an SSL-encrypted
connection.
 

Accept untrusted SSL certicates
 

Select this check box to bypass verication that the mail server SSL certicate is signed
by a trusted certicate authority.
 

Accept expired or not yet valid SSL
certicates
 

Select this check box to bypass verication that the mail server SSL certicate is current
and not yet expired.
 

Accept SSL certicates with
incorrect host name
 

Select this check box to bypass verication that the mail server host name is the same
host specied in the SSL certicate.
 

6. Click Save.

How SMIME Security Works  
In addition to SSL encryption, Oracle-managed Service mailboxes and general Service mailboxes support S/MIME, an
industry standard for ensuring the security of message content through the use of electronic signatures, encryption, or
both.
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An email address that uses S/MIME has a public certicate as well as a private key that corresponds to the public
certicate. The public certicate authenticates the sender and can be used for encryption. The person who replies to
the email can use the sender’s public certicate to encrypt the reply, which can then be decrypted only by the original
sender using the original sender’s private key.

There are certain situations where S/MIME security options are not available.

• In Outreach and Feedback mailboxes.

• When editing multiple incidents simultaneously. You can send a response to more than one incident at a time,
but you cannot use secure mail when doing so.

• When using delayed reporting on the Workspace editor. S/MIME works only if you clear the Delay Report
Execution check box in the Report Behavior drop-down menu for the Contacts relationship item control on the
Workspace editor Design tab. See Overview of Workspace and Script Elements.

This image shows a secure correspondence between two parties, both of whom have S/MIME capability.
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Customers who have S/MIME email can send messages signed with their public certicate to any Oracle-managed
Service mailbox or general Service mailbox. When Techmail receives a signed message, it veries and stores the
customer’s certicate and uses it to encrypt any response messages sent to that customer. The customer can then
decrypt the response using the private key for the certicate.

Note:  Agents responding to a signed message can send a non-encrypted response by selecting Do Not
Encrypt from the incident response options. See Sign and Encrypt an Incident Response.

Service S/MIME seings also let you set conditions on how strictly Techmail validates a customer’s public certicate for
incoming messages. If Techmail cannot verify a customer’s public certicate, it does not update the customer’s contact
record with that certicate.

Tip:  When Techmail aempts to decrypt an incoming message or verify an aached certicate (and you have
enabled the EGW_SAVE_EMAIL_HEADERS conguration seing to save incoming email headers), the results
are appended to the saved mail header.

Note that the customer’s original message is not encrypted. In order to encrypt messages sent from a customer to an
Oracle-managed Service mailbox or general Service mailbox, the mailbox must be congured with its own certicate
and key, as described in the following procedure. Agent response emails are then signed with the mailbox certicate
which customers can use to validate the messages and send encrypted replies. Techmail uses the certicate key to
decrypt those replies and process the message contents normally.

Congure SMIME Security Seings  
In addition to SSL encryption, Oracle-managed Service mailboxes and general Service mailboxes support S/MIME, an
industry standard for ensuring the security of message content through the use of electronic signatures, encryption, or
both.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Mailboxes.

The Mailboxes tree displays on the content pane.
3. Click the mailbox you want to edit in the tree.
4. Click Security on the ribbon.

The mailbox security seings display on the content pane.
5. Enter eld information to identify the mailbox’s public certicate/private key le and set certicate import

requirements.

Field Description

Mailbox personal certicate and key
 

Click the Browse icon to locate the le containing the public certicate and private key
assigned to the mailbox by the certication authority. The le you import should be
in a password-protected Personal Information Exchange PKCS#12 format, using a .pfx
or .p12 le extension. It must also contain the email address of the mailbox exactly as
it was entered for outgoing email. See Edit an Oracle-Managed Service Mailbox. When
prompted, enter the original password (the password used to encrypt the le) and the
new password (the password the private key is to be encrypted with in the database).
 

Note:  The le is not imported until you save all mailbox seings.
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Field Description

Import untrusted certicates
 

Select this check box to bypass verication that the mailbox certicate le will to be
imported (set in the mailbox personal certicate and key eld) or a contact certicate
extracted from a signed S/MIME email is signed by a trusted certication authority.
 
Changing this seing does not aect previously imported and stored certicates.
 

Import expired or not yet valid
certicates
 

Select this check box to bypass verication of the certicate date for the mailbox
certicate le to be imported (set in the mailbox personal certicate and key eld) or a
contact certicate extracted from a signed S/MIME email. The Techmail utility will then
accept certicates from S/MIME emails sent to this mailbox that have expired or are not
yet valid. This seing applies to every certicate in the certicate chain, from the root
certicate through any subordinate certicates to the POP3 server’s certicate.
 
Changing this seing does not aect previously imported and stored certicates.
 

Do not use S/MIME signature
certicates
 

Select this check box to allow unveried S/MIME signed emails for incident creation and
updates. If this check box is selected, certicates from signed emails are not stored with
the contact record.
 

Ignore certicate integrity sign
errors
 

Select this check box to allow incidents to be created and updated even if an email fails
the signature check.

6. Click Save.

Certicate Validation Options  
To supplement the SSL and S/MIME email security seings, Oracle Service Cloud provides you with the resources for
managing the validation and revocation of certicates. These resources are accessed using the File Manager.

• Trusted certication authorities—Service uses a predened list of trusted certication authorities for verifying
certicates from POP3 servers and S/MIME email senders. This list contains well-known root certication
authorities. Depending on your organization’s circumstances, you may want to add or remove trusted
certication authorities.

• Certication revocation lists—Certication authorities regularly publish certicate revocation lists, which
you can use to check the validity of certicates. If you upload any lists, certicate revocation checking
is automatically enabled. As a result, all root certication authority certicates that are used (in either
SSL connections or email certicates) must have a corresponding certicate revocation list. If there is no
corresponding list, the certication check fails.

• Intermediate certicates—Some certicates that are not dened as trusted root certicates still need to
be stored in order to verify a customer’s certicate (the one that was used to sign the customer’s S/MIME
email). These are called intermediate certicates and are automatically extracted from emails, requiring no
intervention on your part. You can also upload intermediate certicates if, for example, you receive signed
emails without the necessary intermediate certicate embedded in them.

Additionally, the conguration seing, USE_KNOWN_ROOT_CAS (Common/General/Single Sign-On), controls
whether the known root certicate authorities list that is embedded within the Oracle server is consulted when verifying
X509 certicates. For example, when checking S/MIME email or SAML 2.0 signatures.
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Related Topics
• Manage Files with the File Manager

Add or Remove Certication Authorities  
Service uses a predened list of trusted certication authorities for verifying certicates from POP3 servers and S/MIME
email senders.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and double-click File Manager.

The File Manager displays on the content pane.
3. Click the Switch To drop-down menu and select Additional Root Certicates.
4. Click Browse and select the root certicate le you want to upload.

The le should be in DER Encoded Binary X.509 (.cer or .crt) or Base-64 Encoded X.509 (.pem) format.
5. Click Go to upload the le.
6. To delete a root certicate le, click the Delete File icon on the line that contains the le you want to delete.

a. Click OK to conrm the deletion.

Add or Remove Certication Revocation Lists  
Certication authorities regularly publish certicate revocation lists, which you can use to check the validity of
certicates.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration and double-click File Manager.

The File Manager displays on the content pane.
3. Click the Switch To drop-down menu and select Certicate Revocation Lists.
4. Click Browse and select the intermediate certicate le you want to upload.

The le should be in a DER Encoded Binary (.crl) format.
5. Click Go to upload the le.
6. To delete a certicate revocation list le, click the Delete File icon on the line that contains the le you want to

delete.
a. Click OK to conrm the deletion.

Add or Remove Intermediate Certicates  
Some certicates that are not dened as trusted root certicates still need to be stored in order to verify a customer’s
certicate (the one that was used to sign the customer’s S/MIME email). These are called intermediate certicates and
are automatically extracted from emails, requiring no intervention on your part.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration and double-click File Manager.

The File Manager displays on the content pane.
3. Click the Switch To drop-down menu and select Intermediate Certicates.
4. Click Browse and select the intermediate certicate le you want to upload.

The le should be in DER Encoded Binary X.509 (.cer, .crt) or Base-64 Encoded X.509 (.pem) format.
5. Click Go to upload the le.
6. To delete an intermediate certicate le, click the Delete File icon on the line that contains the le you want to

delete.
a. Click OK to conrm the deletion.
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How You Troubleshoot Filtered Out or Rejected Email  
Incoming email messages are ltered out or rejected by the Techmail utility for a variety of reasons, such as the header
content, email subject, or because the sender does not have a customer account (that is, a contact record in the
knowledge base).

The logic that determines which email messages are processed is based on mailbox seings, conguration seings, and
the business rules your site uses. The Incoming Email Filter Details report (Public Reports/Service/Email Reports)
can help you troubleshoot why certain emails are being ltered out or rejected by Techmail. This report lists every
email ltered out or rejected in the past twenty-four hours, including the email address the message was sent to, the
date the email was created, the lter type, the lter description, and the name of the mailbox from which the email
was sent. Techmail stores this information in the Techmail Filter Details (tm_lter_details) table. For a description of
information logged in this table, see the Data Dictionary located on the navigation pane ( Conguration > Database >
Data Dictionary ).

This table lists the lter types associated with the Techmail Filter Details table as well as the seings and rules that cause
a message to be ltered out by Techmail.

Filter Type Description

techmail_lter_address
 

This message was ltered out because the email address matches a value on the Addresses tab in the
Discard Filters section of your Incoming Email seings.
 

techmail_lter_header
 

This message was ltered out because the header information matches a value on the Headers tab in
the Discard Filters section of your Incoming Email seings.
 

techmail_lter_subject
 

This message was ltered out because the email subject matches a value on the Subject tab in the
Discard Filters section of your Incoming Email seings.
 

techmail_lter_body
 

This message was ltered out because content in the email body matches a value on the Body tab in
the Discard Filters section of your Incoming Email seings.
 

techmail_lter_mime
 

This message was ltered out because the MIME type matches a value on the MIME Type tab in the
Discard Filters section of your Incoming Email seings.
 

techmail_lter_le
 

This message was ltered out because the le format matches a value on the File Types tab in the
Discard Filters section of your Incoming Email seings.
 

techmail_lter_bulk
 

This message was ltered out because the Delete Bulk Messages check box is selected in your
Incoming Email seings. When Delete Bulk Messages is selected, bulk email messages are not
converted to incidents. Instead, they are deleted. An email is considered bulk when the Precedence:
header is set to bulk, junk, or list.
 

techmail_lter_returned
 

This message was ltered out for the following reasons:
 

• Mailbox type = Service

• Techmail determines the email is a bounced message

• Delete Returned Messages check box is selected in your Incoming Email seings
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Filter Type Description

techmail_lter_wrong_ db
 

This message was ltered out because the system recognized that it came from a separate database.
 
No congurable seing is associated with this lter type.
 

techmail_lter_ autoresponse
 

This message was ltered because of the seing in the Discard Automatic Responses eld (O,
Conservative, Moderate, or Aggressive) in your Incoming Email seings. Based on this seing, the
system detects industry-standard auto-responses, such as Out of Oce, in the subject and header
data.
 

techmail_lter_ duplicate_incident
 

This message was ltered out because the conguration seing EGW_DISCARD_DUPLICATE_
ENABLED is enabled (Default = Yes). In this case, any message that matches an existing incident (with
the same date, email address, subject, and body) is classied as a duplicate.
 

techmail_lter_proof_ reply
 

This message was ltered out because it was a reply to a proof message. Emails related to proof
messages are not processed.
 
No congurable seing is associated with this lter type.
 

techmail_lter_reject_ disabled
 

This message was ltered out because the contact record is disabled.
 
No congurable seing is associated with this lter type.
 

techmail_lter_reject_ reply
 

This message was ltered out for the following reasons:
 

• EGW_REPLY_BETWEEN_ENABLED = Yes (Default = No)

• Force Reply Between Lines check box is selected in your Incoming Email seings.

techmail_lter_reject_ sla
 

This message was ltered out because the system determined that the contact does not have a valid
SLA allowing incidents to be created through email for the specied interface.
 

techmail_lter_reject_ account
 

This message was ltered out because a customer account is required. The system determines a
customer account is required when the following are true.
 

• EGW_AUTO_CONT_CREATE_MA = Yes (Default = No)

• EGW_AUTO_CONT_CREATE = Yes (default)

• Incoming message email address is not associated with a contact record in the knowledge base

techmail_lter_reject_ rule
 

This message was ltered out because of how the business rules of the site are dened.
 

techmail_lter_reject_ smime_sign
 

This message was ltered out because of an invalid S/MIME signature certicate, which is dened by
the S/MIME security seings of the mailbox.
 

techmail_lter_reject_ smime_decrypt
 

This message was ltered out because of a decryption error as dened by the S/MIME security seings
of the mailbox.
 

techmail_lter_ unsubscribe
 

This message generates an email in an aempt to unsubscribe the user from further communication.
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Filter Type Description

Note:  Techmail does process this unsubscribe message in order to ensure the contact is
opted out. The message is considered “ltered” because no incident is created or updated as
a result of the email.

Email Bounce Handling  
Occasionally, a recipient mail server determines that an email message cannot be delivered and replies with a “bounce”
notication (delivery error). To process these errors, the Envelope From/Bounce Address in your Outreach mailbox
outgoing email seings must use the POP server and POP account congured in the incoming seings.

Note:  To ensure that your bounced emails and replies process correctly, you must use the email address that
was provided when your account was set up.

When the Techmail utility encounters a bounce error, it aempts to classify the error as one of the following bounce
types.

Soft bounce—An email was returned because of a temporary problem with the recipient’s mailbox (for example, the
mailbox has exceeded its available size limit). Service incident emails that result in soft bounces are not automatically
re-sent by the system. If you want to resend an incident response that has bounced, you must manually respond to
the incident again. Conversely, when Techmail detects that a soft bounce has been returned from a mailing or survey
invitation email, it places that message in a mail queue and aempts to resend it for up to seven days (the default value
specied by the BOUNCE_RETRY_WINDOW conguration seing).

However, if a contact’s email address returns soft bounces three consecutive times with no contact activity in the
previous fteen days (as specied by the INVALID_NUM_BOUNCES and INVALID_NUM_DAYS conguration seings),
the address is marked invalid. After a contact’s email address has been invalidated, the system does not send mailings
or surveys to that address. See Invalid Contact Email Addresses.

Hard bounce—An email was returned because of a permanent problem with the recipient’s mailbox, and the problem
is not expected to be resolved (for example, the recipient mail server indicates that the email address does not exist).
When a hard bounce is received, the contact email address is marked invalid and no resend aempt is made.

Note:  If email address sharing is enabled, and a shared email address is invalidated due to a hard bounce, the
address is marked as invalid for each contact associated with it. See Email Address Sharing.

General bounce—A mailing or survey invitation email was returned due to technical problems with the delivery of the
message. That is, the problem is not on the sender’s end nor the recipient’s end, but in the transmission of the message
over the network in between. It is therefore dicult to predict the likelihood of resolution. General bounces are logged
in the database but no further action is taken. No resend aempt is made and the contact email address is not marked
invalid.

Unknown bounce—An email was returned for a reason that could not be determined. Unknown bounces are logged in
the database but no further action is taken. No resend aempt is made and the contact email address is not marked
invalid.
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In other cases, Techmail may receive an error code indicating that a mailing or survey invitation email was blocked by
the recipient mail server. When this happens, Techmail aempts to identify the reason for the block and classies it as
one of the following block types.

• Content block—An email was blocked due to its content. In other words, some part of the message content
triggered a lter that prevented the message from being delivered.

• Sender block—An email was blocked due to the sender’s reputation. This means that the sender has not
developed a trusted relationship with the recipient mail provider.

• General block—An email was blocked for a reason that could not be determined.

When Techmail encounters a block error, it logs the error in the database but does not aempt to resend the message,
nor does it invalidate the contact email address.

Delivery errors logged by the system can be accessed with reports, specically the Invalid Email Address Domains report
(Public Reports/Outreach/Contacts/Database Snapshot) and the Invalid Email Addresses by Mailing report (Public
Reports/Outreach/Contacts).

You may also nd it valuable to build a custom report using other data stored in the Bounced Messages
(bounced_msgs) table. For example, you could create a custom report that includes the email address that the message
was sent to, the text of the error received, the type of block or bounce it was classied as, and whether the email address
was invalidated as a result. See Overview of Custom Reports.

Oracle Service Cloud stores a copy of the original email message for 60 days. (You can change or disable this purging
interval by editing the OE_BOUNCE_PURGE_DAYS conguration seing.) See Edit a Conguration Seing.

When a delivery error is returned from an incident response, a View Bounce Messages buon appears in the header
of the response thread that was bounced. Clicking this buon opens a window displaying the contents of any delivery
errors resulting from the response. See View a Bounced Message.

Note:  Because email technology is constantly evolving, Oracle Service Cloud regularly monitors delivery
errors that are not categorized and aempts to classify them accordingly. If an email is blocked or bounced for
a reason that cannot be determined (an unknown bounce or general block has occurred), it is often because
not enough information was provided by the delivery error to classify it appropriately.

Invalid Contact Email Addresses  
In a contact workspace, an invalid email address is agged by a warning indicator to the right of the Email eld.

In the database, validity is tracked for primary and alternate email addresses in three elds: contacts.email_invalid,
contacts.email_alt1_invalid, and contacts.email_alt2_invalid. When these elds are updated, the contact audit log
is updated accordingly. These elds can also be used in reports or as conditions in an incident or contact rule. See
Overview of Creating Basic Custom Reports and Overview of Business Rules.

If an agent aempts to send an incident response to a contact with at least one valid primary or alternate email address,
Oracle Service Cloud sends the message to the valid address and no warning is given. However, if an agent aempts to
send a response to a contact whose primary and secondary email addresses are all marked invalid, Oracle Service Cloud
displays a warning message asking whether to proceed. If the agent clicks Yes, the system sends the response and sets
all of the email addresses back to a valid state. However, if the response results in a bounce message that indicates an
address is still not valid, Techmail invalidates the address once again.

Especially useful for identifying invalid email addresses is the Contacts with Invalid Email Addresses report you (Public
Reports/Common/Contact Reports). This report lists all contacts with one or more invalid primary or alternate email
address, resulting from both hard and soft bounces. It also lists the most recent invalid date.
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Tip:  It is not possible to override bounce detection to prevent Techmail from seing an email address to
invalid. However, if a message that is not a bounce message is received from an address agged as invalid,
Techmail automatically updates the contact and revalidates the address. You can manually revalidate a
contact’s address by slightly modifying it, saving the record, and then reopening the record and seing it back
to its original state. For example, if you change the address joe@example.com to joe@example.com.invalid
and save the contact, then change it back to joe@example.com, the address is set as valid.

Email Loop Detection  
Occasionally, an email message may be sent to an address that returns an automated reply (such as an out-of-oce
notication). If Techmail then receives and processes the automated reply, another message (such as an incident receipt
or rule response) could be sent, generating another automated reply, forming an email loop.

To avoid this problem, the Techmail utility automatically terminates email loops using three detection methods.

• Duplicate messages—If Techmail detects that it has processed an identical email earlier in the same run, the
duplicate email is deleted. Emails are considered duplicates if they are found in the same mailbox and contain
the same email address, subject, send date, and body as a previous message.

• Oracle Service Cloud messages—Techmail also looks for any incoming message header that contains a reply-to
address matching the reply-to address of any mailbox. In this way, Techmail deletes any messages originating
from the system (such as receipts and escalation notications) to prevent continuous internal email loops
within Service.

• Multiple messages—Techmail also enforces a maximum number of messages allowed from a single email
address in a specied period of time, regardless of content. By default, no more than twenty-three messages
are allowed from the same address in the same twelve-hour period. Additional messages from that address
within that time period indicate that an email loop has occurred and are deleted to terminate the loop.

Note:  To ensure accurate processing of replies, inbound messages, and bounces, Outreach mailboxes
cannot be shared with either type of Service mailbox. Techmail handles messages in Oracle-managed Service
mailboxes and general Service mailboxes dierently from how it handles them in Outreach mailboxes. For this
reason, you must set up one mailbox for Service and a separate mailbox for Outreach and Feedback.

This table describes the conguration seings you can use to congure the Techmail email loop prevention function.
See Edit a Conguration Seing.

Seing Description

RightNow Common/Service Modules/Oracle Email

EGW_LOOP_PREVENT_ENABLED If enabled, any email where the reply-to email address matches the reply-to email address of any
Oracle-managed Service mailbox, general Service mailbox, or Outreach mailbox is discarded and
no incident is created. In this way, the mailbox deletes any messages from itself, which can prevent
continuous email loops. Default is enabled (Yes).
 

EGW_DISCARD_DUPLICATE_ENABLED If enabled, any email having the same date, email address, subject, and body as an existing incident are
classied as a duplicate message and are discarded. Default is enabled (Yes).
 

EGW_MAX_MSG_DURATION Species the number of hours in which EGW_MAX_PER_ADDRESS is calculated. By default, the system
only accepts 23 messages from a given email address in a 12-hour period. Since a high number of
messages in a short period of time is reasonable, it is recommended the duration not be less than 8
hours or more than 24 hours. Default is 12.
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Seing Description

 

EGW_MAX_PER_ADDRESS Species the maximum number of emails that are accepted from an individual email address within
a EGW_MAX_MSG_DURATION hour period. This is used to identify and stop auto-responder email
loops. For example, if this seing is set to 23, and 24 emails are received from the same address within
EGW_MAX_MSG_DURATION hours, the 24th email from that address is discarded and no response
email is sent, thereby breaking the email loop. Seing the value to zero turns o this loop detection.
Default is 23.
 

In the rare event that Techmail’s automated detection features are insucient to prevent an email loop, you can use
either of the following options to break the loop by temporarily discarding messages received from a specic email
address.

• To end a loop using business rules, set up a temporary rule to delete email received from the address causing
the loop. See Add a Rule.

• To end a loop using mailbox seings, temporarily add the email address to the Discard Addresses eld for
incoming email on the Mailboxes editor. See How Mailboxes Work and Edit an Oracle-Managed Service Mailbox.

Advanced Conguration for Email Handling  
To beer t our email management processes to your business needs, you can customize a variety of conguration
seings to modify default behavior of the system.

The seings described in the procedures found in this section are used to congure mail processing functions such as
the email gateway, contact record creation, email loop prevention, and mailer daemon (also called RNMD) parameters.
See How the Conguration Seings Editor Works.

Edit Common Outgoing Email Conguration Seings  
You can congure the resend limit, custom headers, single-send email response logic, and the number of days before
purging the message eld from the Conguration Seings editor.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens, where you can lter your search results.
3. To display all outgoing email seings, select the Site check box (in addition to the Logged In check box, which is

selected by default) below the Conguration Base eld.
4. Clear the Select All check box below the Folders eld and then select the Common check box.
5. To search for a specic conguration seing in the Common folder, enter the seing name in the Key eld.

Tip:  You can search part of a conguration seing name by appending a wildcard (either an asterisk
or a percentage sign) to the end of your search term.

6. Click Search.
The Conguration Seings editor displays the seings in the Common folder that match your search criteria.
To display conguration seings in alphabetical order, click in the Key column header.

7. Expand the folders under Common/General and edit the conguration seings in the Outgoing Email folder.
For information about a seing, click the seing and see the description that appears on the Conguration
Seings editor. For complete details about the Conguration Seings editor, including searching, editing, and
creating custom conguration seings, see Edit a Conguration Seing.
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Related Topics
• Overview of Site Conguration

Edit Service Email Conguration Seings  
You can congure mail processing functions such as the email gateway, contact record creation, contact association
priority for incoming email, and email loop prevention from the Conguration Seings editor.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens, where you can lter your search results.
3. Clear the Select All check box below the Folders eld and then select the RightNow Common check box.
4. To search for a specic conguration seing in the RightNow Common folder, enter the seing name in the Key

eld. (The Key eld is not case sensitive.)

Tip:  You can search part of a conguration seing name by appending a wildcard (either an asterisk
or a percentage sign) to the end of your search term.

5. Click Search.
The Conguration Seings editor displays the seings in the RightNow Common folder that match your search
criteria.
To display conguration seings in alphabetical order, click in the Key column header.

6. Expand the folders under RightNow Common/Service Modules and edit the conguration seings in the
Oracle Email folder.
For information about a seing, click the seing and see the description that appears on the Conguration
Seings editor. For complete details about the Conguration Seings editor, including searching, editing, and
creating custom conguration seings, see Edit a Conguration Seing.

Related Topics
• Overview of Site Conguration

Edit Outreach and Feedback Email Conguration Seings  
You can congure mail processing functions such as bounced email processing, delivery of campaigns and mailings,
invalid contacts, and mailer daemon utility (also called RNMD) parameters from the Conguration Seings editor.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens, where you can lter your search results.
3. Clear the Select All check box below the Folders eld and then select the Outreach and Feedback check box.
4. To search for a specic conguration seing in the Outreach and Feedback folder, enter the seing name in the

Key eld. (The Key eld is not case sensitive.)

Tip:  You can search part of a conguration seing name by appending a wildcard (either an asterisk
or a percentage sign) to the end of your search term.

5. Click Search.
The Conguration Seings editor displays the seings in the Outreach and Feedback folder that match your
search criteria.
To display conguration seings in alphabetical order, click in the Key column header.

6. Expand the folders under Outreach and Feedback/General.
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7. Edit the conguration seings in the specic Bounced Mail Processing, Campaigns, Invalidate Contacts, Mailer
Utility, Mailings, Miscellaneous, and RNM Daemon folders.
For information about a seing, click the seing and see the description that appears on the Conguration
Seings editor. For complete details about the Conguration Seings editor, including searching, editing, and
creating custom conguration seings, see Edit a Conguration Seing.

Related Topics
• Overview of Site Conguration

Add or Edit a Distribution List  
Distribution lists are email address lists that you can use when scheduling reports, conguring rule notications,
and forwarding incidents and opportunities. You can also use email address lists in the CC and BCC elds in incident
responses.

Distribution lists are used to dene sets of email addresses not associated with contact records or sta accounts in your
knowledge base. For example, you might want to schedule an email report to be sent to a group of executives who do
not have sta accounts in Oracle Service Cloud. By adding their addresses to a distribution list, you can then include
that list when dening subscribers to that report.

You can see all of the distribution lists your organization uses in the Distribution Lists report, located in Public Reports/
Common/Site Administration/Communication Conguration.

The Distribution Lists editor consists of a list of available addresses. Addresses are included in the distribution list by
selecting the check box next to the address in the list.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Distribution Lists.

The Distribution Lists tree displays on the content pane.
3. Do one of the following:

◦ To add a distribution list, click New on the ribbon.

◦ To edit a distribution list, click it in the tree.

4. Enter the distribution list name in the List Name eld.
5. To add an internal note about the distribution list, enter it in the Notes eld.
6. Enter eld information.

Field Description

Distribution List Members
 

This section contains the list of addresses available for the distribution list.
 

Filter
 

Enter lter text and click the drop-down menu to select a column to lter the address
list. Filtering is available only when editing a list that has been saved.
 

Click this buon to add a new address to the address list.
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Field Description

Click this buon to open the Import Email Addresses window and enter multiple email
addresses that you want to add to the address list. You can also add rst and last names
for each address.
 

Note:  You can copy and paste a list of contact email addresses into the Email
eld, but each address must appear on its own line followed by a return.

Select All
 

Select this check box to include all available addresses in the distribution list, or select
the check box next to an individual record to include the record in the distribution list.
 

Click this buon to remove the selected member from the address list.
 

CAUTION:  Deleting the email address removes it from all distribution lists
that it has been added to.

Click this buon to copy the selected address in the address list.
 

*Email
 

Enter the email address.
 

First Name
 

Enter the rst name associated with the email address.
 

Last Name
 

Enter the last name associated with the email address.
 

Notes
 

Enter internal notes about the email address.
 

7. To enter a dierent name for the distribution list based on interface, select the Label value next to the Language
name in the Interface Label section and enter the name.
This is helpful if your site has multiple interfaces of dierent languages. By default, the label is set to the list
name you dened in step 4.

8. To view the audit log, click the Audit Log buon on the ribbon.
9. Click Save.

Related Topics
• Add Email Addresses to Distribution Lists
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Add Email Addresses to Distribution Lists  
You can add email addresses to your distribution lists from the Distribution Lists editor. You can also copy and paste
multiple addresses that are saved in another program, such as Microsoft Word, Excel, or Notepad. After the email
addresses are added, new addresses can be included in distribution lists.

1. On the Distribution Lists editor, click Import.
The Import Email Addresses window opens.

2. Do one of the following:

◦ Enter the email addresses you want to add.

◦ Copy and paste multiple email addresses from another program.

Note:  Each address must appear on a single line followed by a return.

3. To include rst and last names along with an email address, you must type that information (on a single line
followed by a return) in the following order and format.

<rst name>, <last name>, <email address>

For example, Lucy, Bauer, lucybauer@example.com

4. Click OK to add the email addresses to the distribution list.
A message tells you that any changes made to distribution lists will be saved rst and asks if you want to
continue.

5. Click Yes.
A Success window displays.

6. Click OK.

Related Topics
• Add or Edit a Distribution List

Best Practices for Sending Email  
We follow key internal processes to protect the integrity of our hosted mail domains. In addition, we promote
and enforce high standards of behavior among our customers who share resources in our multi-tenant hosting
environment.

As an administrator, it is equally important to align your processes with the best practices described here to minimize
the risk of interference with your email communication. Many external factors can impact the deliverability of email.
Due to the vast amount of spam transmied to consumers each day and the aggressive systems used to combat it,
legitimate business emails are sometimes ltered without notice. In addition, customers who do not recognize the
sender or contents of a valid message may regard it as spam, puing organizations at risk of having their addresses
blacklisted by ISPs or email-reputation management services.

Note:  The following practices apply only to mail sent from Service.

338



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Implement authentication—Organizations that send messages from branded domains should use a form of
authentication to protect their reputations and delivery rates, while guarding against so-called “phishing” scams and
forged messages.

• Sender Policy Framework—Sender Policy Framework (SPF) is an email authentication option that designates
permied senders of email originating from your domain, excluding those with mismatched or incorrectly
specied SPF records. If your email address was supplied by Oracle using custhelp.com or rnmk.com domains,
SPF has been implemented for you and no further action is needed. Otherwise, see  Answer ID 2489  on our
support site for information about implementing SPF on your site.

• DomainKeys/DomainKeys Identied Mail—DomainKeys (DK) and DomainKeys Identied Mail (DKIM) are email
authentication options that use cryptographic signatures to designate email as originating from an authorized
email delivery provider, excluding messages sent from those with unsigned or incorrectly assigned signatures.
If we supplied your email address using custhelp.com or rnmk.com domains, your emails are already signed by
Oracle Service Cloud and no further action is needed. Otherwise, see  Answer ID 2701  on our support site for
information about implementing DK and DKIM on your site.

Include your address and privacy policy—Edit your mail footers to include your business address and a link to your
privacy policy. All emails governed by the CAN-SPAM law must contain the physical address or post oce box of your
organization. In addition, a link to your organization’s privacy policy explaining how prole information is used can build
trust with your contacts. For information about editing your mail footers, see How the Message Templates Editor Works
and How You Customize the Global Template.

Review invalid email addresses—Use reports to regularly monitor all contacts marked as invalid. A high percentage
of invalid addresses indicates a need to reevaluate your contact record maintenance practices. In addition, the Invalid
Email Address Domains report helps you check for contact email addresses from well-known domains that contain
common typographical errors (such as “htomail.com” instead of “hotmail.com”). For information about creating and
using reports, see Overview of Creating Basic Custom Reports.

Send from familiar addresses—Use easily identiable email addresses in your mailbox conguration to help recipients
recognize your organization as the sender. Do not include special (non-alphanumeric) characters, as they can cause
lters to falsely identify the email as spam.

Rene the message subject—The subject line is the rst part of your message that your contacts see, so it must
be concise and informative. When responding to an incident, make sure the subject clearly states the topic being
discussed. If a contact fails to enter a descriptive and accurate subject, consider modifying it for clarity.

Promote addition to address books—Ask contacts to add your email address to their address books. This rearms their
interest and ensures consistent delivery of your messages to their inbox.

Avoid using content associated with spam—Do not use all caps, special characters, or certain words often associated
with spam in incident responses, as these can register false positives in many spam lters.

Honor abuse complaints—Regularly monitor administration accounts, such as abuse@yourdomain.com or
postmaster@yourdomain.com, and honor all abuse complaints as unsubscribe requests by opting out or disabling the
associated contact record.

Note:  The Answer Update notication message is one of several subscription-based notications sent from
Service and includes an unsubscribe link for each updated answer. If an answer matches multiple subscription
criteria (for example, it was subscribed to by both answer ID and product), the message provides options
to unsubscribe from each subscription type. In this way, a contact can unsubscribe from answers without
assistance from your sta.
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Message Templates  

Overview of Message Templates  
Message templates let you customize your administrator notications, administrator emails, and contact emails for each
interface.

You can customize your message content, enable and disable notications and emails, as well as dene the message
format as HTML or text. Message templates also let you quickly apply your organization’s brand across all notications
and emails, including Oracle RightNow Cloud Service (Service) email.

Note:  Sta members must have the Message Templates permission on the Administration tab of the Proles
editor in order to customize message templates. See Administration Permissions.

How the Message Templates Editor Works  
The Message Templates editor contains the global template and a set of system-generated messages.

Using an HTML editor similar to the HTML editors used to create content for mailings, surveys, and answers, you can
edit the global template and the messages directly on the Service Console. See How the HTML Editor Works.

The global template contains the content that frames the message-specic content in each of your individual
messages. Think of the global template as a wrapper for your entire set of notications and emails. Using the HTML
editor, you can standardize the design of your outgoing messages giving them all the same look and feel. For example,
you can insert your organization’s logo in the header and your customer service information in the footer of the global
template. When you are ready to deploy your global template, your brand can be applied to a single message or across
all of your messages.

This image shows the global template open on the Message Templates editor.
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Legend for image: 1. Image placeholder that you can replace with your own logo.

The system-generated messages are sent to sta and contacts to support activities and events occurring throughout
the system. Using an HTML editor, you can personalize your email subject lines to tailor your message to dierent
audiences with advanced editing. You can also insert links that appear as clickable text and use merge elds to
customize each message. The tools that display on the HTML editor are context-sensitive and are the logical tools you
would use for the specic message you are customizing.

Additionally, you can edit multiple messages at the same time, which is especially useful if you want to compare similar
messages or if you work with more than one interface. Each time you edit a message template, it opens on a subtab,
making it easy to move between dierent message templates.

This image shows the Incident Closed message template open on a subtab. The dierent types of context-sensitive
tools and links included on this specic message template are highlighted.

Legend for image: 1. Advanced editing buon 2. Context-sensitive link 3. Merge eld 4. Incident thread

Message Templates Ribbon  
The message templates ribbon contains buons for accessing the individual system-generated messages and for
working with the global template. You can view the live global template, edit and deploy the global template, and deploy
the entire set of messages and the global templates across all interfaces at the same time.

Note:  The buons on the message templates ribbon are inactive until you select the interface you want to
customize.

Some buons apply only to the global template while others apply to the system-generated messages. Those
dierences as well as the buons available on the message templates ribbon are described in this table.
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Group/Buon Description

Save
 

The buons in this group commit changes to the database for the global templates as well as the
messages across all interfaces.
 

Save
 

Click this buon to commit pending changes and keep the editor open.
 

Save and Close
 

Click this buon to commit pending changes and close the Message Templates editor.
 

Actions
 

Refresh
 

Click this buon to abandon pending changes and reload the most recently saved version. This buon
applies to the global template as well as the messages.
 

Show
 

The buons in this group let you switch between the dierent message types that are available.
 

Administrator Notications
 

Click this buon to open the categories for administrator notications.
 

Administrator Emails
 

Click this buon to open the categories for administrator email messages.
 

Contact Emails
 

Click this buon to open the categories for contact email messages.
 

Print Pages
 

Click this buon to open the print templates available for viewing records and items from the
agent desktop as well as printing hard copies of incidents, answers, tasks, organizations, contacts,
 opportunities, and quotes.
 

Global Template
 

The buons in this group apply to the global template that is used to apply a standard look and feel
across all of your messages.
 

Edit Template
 

Click this buon to open the global template.
 

View Live Template
 

Click this buon to view the most recently deployed global template.
 
Before you click the Deploy Template buon, View Live Template displays the active version that has
been deployed on your site. After you click the Deploy Template buon, the version you are editing
displays. However, it has yet to be commied to the database.
 

Deploy Template
 

Click this buon to deploy the edited version of your global template. At this point, the deployed
version is applied to the entire set of messages. Keep in mind that you have not commied this version
to the database.
 

Note:  You must click Save to commit your deployed version to the database. After you save,
 your global template is active.

Edit
 

The buons in this group dene the mode (either design or source) in which the global template and
the entire set of messages open on the HTML editor.
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Group/Buon Description

Design
 

Click this buon to set the global template and the messages to open in design mode on the HTML
editor. This is the default mode.
 

Source
 

Click this buon to set the global template and the messages to show the source code on the HTML
editor.
 

Proong
 

Spelling
 

Click this buon to spell check the global template.
 

Deploy
 

Deploy All
 

Click this buon to deploy the global templates as well as the entire set of messages across all
interfaces at the same time.
 

Note:  You must save after clicking the Deploy All buon to commit your edits to the
database.

Message Templates Subtabs  
Managing multiple message templates across multiple interfaces is easy through the use of content pane subtabs.

Using the Message Templates editor, you can work with multiple templates at the same time, which is especially useful
if you want to compare similar messages or if you work with more than one interface. In addition, you can also move
to other areas of Oracle Service Cloud without needing to close your message templates. For instance, say you need to
open an incident while you are editing your message templates. There is no need to close the message templates you
are working on because you can move to your incident workspace and come back to your message templates when you
are ready. Here's how they work.

When you open a message template, the Home tab displays as does the tab for the message template. Both tabs appear
below the Message Templates editor content pane tab and are called subtabs. This image shows the Incident Solved
message template for two separate interfaces, each one open on its own subtab.
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Notice the number in parentheses on the Message Templates editor tab. This identies the number of subtabs you
currently have open (in this case, the number 3 represents the Home subtab and two Incident Solved subtabs).

You'll use the Home subtab when you want to return to the Message Templates main editor to open other templates or
the global template. As shown in this image, clicking the Home subtab displays the interfaces you have available on the
left and a list of categories for the message type (administrator notications, administrator emails, contact emails, or
print pages) displays on the right. From here you can select a template to open or click a buon on the Show group of
the ribbon to change the message type.

If you want to edit the global template, click the Home subtab, click the applicable interface on the left, and click the Edit
Template buon on the ribbon as shown in this image.
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Note:  Because each interface has its own global template, you cannot edit more than one global template at
the same time.

As shown in the image, each message template subtab contains buons that correspond to the buons on the Editor
group of the Message ribbon: OK, Cancel, and Undock. All subtabs, except for the Home subtab, contain these buons
for taking actions on the individual message templates. From the active subtab (or when you hover over an inactive
subtab), these buons let you save and cancel your changes as well as undock your message template without needing
to use the ribbon buons. Hovering over a subtab also shows a tooltip that includes the name of the message, interface,
and the last updated and deployed dates.

• OK—Clicking this buon accepts the changes you have made and closes the subtab. However, it does not save
changes to the database until you click the Save or Save and Close buon on the message templates ribbon.

• Cancel—Clicking this buon closes the subtab if you haven’t made changes to the message template. If you
have made changes, a message asks if you want to save your changes.

• Undock—Clicking this buon undocks the message template from the editor and opens it in its own window. To
redock the message to the editor, click the Dock to Console buon on the window ribbon.

How You Customize the Global Template  
The global template contains the content that frames the message-specic content in your individual messages. You
can standardize the look of your messages by inserting your own logo. You can also customize your headers and footers
to display information that needs to be communicated in all of your messages.
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Note:  Because each interface has its own global template, you cannot edit more than one global template at
the same time.

In the middle of the HTML editor for the global template are two placeholders—one is an image placeholder and the
other is a placeholder for the message-specic content. You can insert HTML above and below the placeholders. The
global template, like all messages, is interface specic.

Tip:  Since the system default global template cannot be restored from the Message Templates editor, we
recommend that you copy and paste the original template HTML into a text le, such as Notepad, in case you
need it at a later time. You can do this from the Source tab on the HTML editor.

Edit the Global Template  
You can edit the global template to customize the content that frames the message-specic content in each of your
individual messages.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Message Templates.

The Message Templates editor opens.
3. Select the interface you want to customize. By default, the categories for administrator notications display on

the right.
4. Click Edit Template on the ribbon.

The global template for the interface you selected opens.
5. To insert your logo or another image, double-click the image placeholder to the right of the content

placeholder.
The Image Editor window opens. See Insert an Image.

6. To edit the global template using the hyperlinks, buons, and other features available on the HTML editor, use
the HTML editor. See How You Add HTML in Design Mode.

7. To customize your header and footer content, enter above or below the placeholders.
8. To discard your pending changes and revert to the most recently saved global template, click Refresh on the

ribbon.

Note:  Refresh applies only to the most recently saved global template. For example, if you have made
changes and have not saved, then you can refresh to your previous version. However, after you save,
then that is the version that is available to refresh.

9. To see the currently deployed template, click View Live Template on the ribbon.
The content pane refreshes to display the version of the global template that is currently applied to all
notications and messages.

Tip:  Suppose you have made changes, but want to go back to some of the elements used in your
active version. As long as you haven’t deployed your template, clicking View Live Template lets you see
a read-only version of the active content that you can copy and paste into the version your are editing.

10. To spell check the global template, click Spelling on the ribbon.
11. To preview your changes to the global template, click the Preview tab at the boom of the HTML editor.
12. Click Save on the ribbon to save your edits to the global template.

At this point, your changes are not active because they have not been deployed or commied to the database.
See How You Deploy the Global Template.
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How You Deploy the Global Template  
When you deploy the global template, you copy the version you are currently editing to the version that is sent
throughout the system to the entire set of messages.

After you deploy, you still have the option to make changes to your global template because you have not commied
anything to the database. It is also true at this point that you can no longer view the active version of the global
template. After you save, your deployed version is the only one you can see.

To make your deployed version active, you must commit your changes to the database by saving after you deploy. It
is only after you have saved your deployment that your global template changes are active and are also applied to the
entire set of active messages.

Note:  Because each interface has its own global template, you cannot edit more than one global template at
the same time.

Deploy the Global Template  
If you’ve made changes to your global template but have not changed any of your individual messages, the global
template is all you need to deploy.

1. After saving changes to the global template, click Deploy Template.
A message asks you to conrm your decision to deploy.

2. Click OK.
Your deployed version is copied to the version that is sent throughout the system.

Note:  At this point, if you click View Live Template, the version you are editing displays. Likewise, if
you open any of your messages, your edited version has been applied, but it has yet to be commied
to the database.

3. Click Save to commit your deployed version to the database.

Now, your deployed version is your active global template and is applied to your entire set of active messages.

Deploy the Global Template and the Messages at the Same Time  
If you’ve made changes to both your global template and any of your individual messages, you can deploy everything at
the same time.

1. After saving changes to the global template, click Deploy All.
A message asks you to conrm your decision to deploy the global template as well as all of your messages.

Note:  Deploy All applies to the global templates and messages across all interfaces.

2. Click OK.
Your deployed version is copied to the version that is sent throughout the system and the Last Deployed labels
on all of your messages display “Pending...” under the message descriptions. However, neither your deployed
global template nor your messages are active at this point.

3. Click Save to commit your deployed version and all of your messages to the database.

Now, your deployed version is your active global template and is applied to your entire set of messages. Your deployed
messages are also active.
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How You Customize Messages  
Oracle Service Cloud provides a variety of system-generated messages that are sent to sta members and contacts to
support activities and events occurring throughout the system.

All messages are enabled by default, but you can disable messages that you don’t need. You can also dene the
message format (HTML or text) as well as edit and deploy a single message or all messages.

Tip:  Remember to use the global template to apply your organization’s branding across all your messages.

At the top of most message templates is a subject line that you can customize to tailor your message to dierent
audiences. You can also add merge elds and conditions to your subject line to further personalize your subject.

Note:  There are certain message templates that do not contain a subject line, such as those that forward
emails and print templates as well as the Survey Proof and Send Quote templates.

Messages open with standard HTML editor tools such as links that appear as clickable and dynamic content, including
case sections, conditional sections, incident threads, and merge elds and reports. Tools that display on the HTML
editor are context-sensitive and are the logical tools you would use for the type of message you are customizing. For
complete details on how to use these context-sensitive tools in messages, see How You Add HTML in Design Mode.

Message Types  
The buons on the Show group on the message templates ribbon can be used to switch between the dierent types
of messages that are available, including administrator notications, administrator email messages, and contact email
messages.

Administrator notications—Oracle Service Cloud can send automatic notications to alert sta members of key events
such as incident escalations, answer, task and opportunity assignments, mailing completions, and system errors. You
can also send custom broadcast notications containing short text messages from the Notications component on
the agent desktop. Sta members are alerted to new notications through a toast and can view all their notications
from the Notications component. When a notication is sent to sta members who are not logged in to Oracle Service
Cloud, a notication email is sent instructing them to log in to view the notication. See Notications.

Tip:  To send emails containing more information about the event that triggered a notication, you can select
a detailed notication option from the Email Notications menu on the Sta Accounts editor (see Add or Edit
a Sta Account). Sta members can also set notication preferences in their personal seings (see Change
Your Personal Seings).

Administrator email messages—Incident, opportunity, answer, and task information can be automatically emailed to
sta members by business rules or forwarded manually. Contact, organization, and asset information can be forwarded
manually. Sta members can also be sent automated account assistance emails if they have diculty logging in.

Contact email messages—Customers can receive a broad range of email messages supporting their activities on your
site, such as incident receipts and responses, answer and community update subscriptions, and account assistance
requests.
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Links and Dynamic Content Elements  
Oracle Service Cloud contains an HTML editor for creating dynamic content in messages. When you edit a message,
you can use word processing functions to create HTML, as well as dynamic content, such as case sections, conditional
sections, or incident threads.

You can add several types of links and dynamic content to your content. Links appear as clickable text when the
document is used in a message. When a link is added, you have the option of dening certain aributes depending on
the type of link. Links and dynamic content elements are located in the toolbox.

Note:  The tools that display on the HTML editor are context sensitive and are the logical tools you would use
for the specic message you are customizing. Links and dynamic content that were designed with message
templates in mind are described in the following table. For a complete list of links, including those not listed in
the following table, see the Toolbox Section table in How You Add HTML in Design Mode.

Buon Description

Links
 

Buons in this section are used to insert the available context-sensitive links in your message content.
 

Account Assistance Link
 

Inserts a link to the Account Assistance page on your customer portal where customers can request an
email containing either their user name or a link to a page for reseing their password. See Insert an
Account Assistance Link.
 

Agent Browser UI Incident Link
 

Inserts a link to the incident that triggered the sent message so that agents can access the incident
from the Agent Browser User Interface. See Insert an Agent Browser UI Incident Link.
 

Answer Link
 

Inserts a link to any answer you specify. See Insert an Answer Link.
 

Customer Portal Incident Link
 

Inserts a link to the incident that triggered the sent message. For example, the standard Question
Receipt email sends a conrmation message after a customer submits a question through the Ask a
Question page, an email, or a chat session. By adding a Customer Portal Incident Link to your Question
Receipt message template, you can provide your customers with easy access to the incident created
from their question. See Insert a Customer Portal Incident Link.
 

Incident Link
 

Inserts a link to any incident you specify in the message. See Insert an Incident Link.
 

Prole Link
 

Inserts a link to the Account Seings page on your customer portal where customers can change their
user name and update their prole information. See Insert a Prole Link.
 

Proof Comments Link
 

Inserts a link to a web page where the recipient can give feedback about the survey they have been
asked to proofread. See Insert a Proof Comments Link.
 

Proof Survey Link
 

Inserts a link to the survey you want your proofreaders to review. See Insert a Proof Survey Link.
 
This link is included, by default, on the Survey Proof message template.
 

Setup Password
 

Inserts a link to the Finish Account Creation page on your customer portal. See Insert a Setup Password
Link.
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Buon Description

Survey Link
 

Inserts a link to a survey. See Insert a Survey Link.
 

Survey Results Link
 

Inserts a link to a web page that shows the survey responses. Insert a Survey Results Link.
 
This link is included, by default, on the Survey Notication message template.
 

This Answer Link
 

Inserts a link to the incident that triggered the sent message. See Insert a This Answer Link.
 

This Discussion Link
 

Inserts a link to the email discussion that triggered the sent message. See Insert a This Discussion Link.
 

Unsubscribe All Answers Link
 

This buon inserts a link that lets contacts who receive answer notications unsubscribe from future
communications. See Insert an Unsubscribe All Answers Link.
 

Unsubscribe This Answer Link
 

Inserts an unsubscribe link to a specic answer that’s been returned as the result of a repeatable
answer section. See Insert a This Answer Link.
 

View Subscriptions Link
 

Inserts a link customers can use to update the list of notications they are subscribed to. See Insert a
View Subscriptions Link.
 

Dynamic Content
 

Buons in this section are used to insert dynamic content in your message content.
 

Aached File List
 

Inserts a list of le aachment links that will display as long as aachments have been added to the
record the template is referencing. See Print Templates.
 
This buon is available only for print templates.
 

Answer Section
 

Click this buon to add any repeatable answer details on your answer update notication messages.
See Insert an Answer Section.
 

Case Section
 

Click this buon to add a case section to your conditional text. See Insert a Case Section.
 

 
Conditional Section
 

Inserts a conditional section that you can dene to lter content by contact, prole, runtime variable,
 or record type. For example, you could add a conditional section that displays a coupon based on the
product specied in the incident. See Insert a Conditional Section.
 

Incident Thread
 

Inserts an incident thread that displays all communication between the parties associated with the
incident. See Insert an Incident Thread.
 

Merge Field
 

Inserts a merge eld. See Insert a Text Merge Field.
 

Merge Report
 

Inserts a merge report. See Merge a Report into Content.
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Print Templates  
Standalone print templates are available for viewing records and items from the agent desktop as well as printing hard
copies of incidents, answers, tasks, organizations, contacts, opportunities, quotes, and assets.

You can customize these templates to apply your organization’s brand, add dynamic content, and display any custom
elds you may be using. In addition, print templates have been designed to include a list of le aachment links. As long
as le aachments exist in the record that the print template references, then that list of aachment links will display.
This is especially useful for agents who frequently reference answers. See Links and Dynamic Content Elements.

Display Sibling Answer File Aachments on the Answer Print Message Template  
You can specify le aachment properties on the Answer Print message template so that sibling answers display any
aachments included in the sibling answer. When sibling aachments are set to display, the aachment le names are
listed when you print a hard copy.

Sibling answers must be enabled on the answer workspace for the list of sibling le aachments to display. See Sibling
Answers and Options Properties. In addition, the Aached File List element is included by default on the Answer Print
message template. If the Aached File List element has been removed, you must add it to the template before starting
this procedure.

1. From the Answer Print message template, do one of these:

◦ Double-click the File Aachments List element.

◦ Right-click the File Aachments List element and then select Aached File List Properties.

The File Aachments List window opens.
2. Select Show Sibling Aachments.
3. Click OK.
4. Click Save.

Note:  You must deploy and commit your changes to the database before they will take eect. You
must also log out and then log back in to see the changes on your site. See Deploy One Message.

Any sibling aachments associated to an answer display in the le aachments list on your Answer Print message
template.

Message Ribbon  
When you edit a message, it opens below the Message Templates editor content pane tab on its own subtab with its
own ribbon.

Group/Buon Description

Editor When you undock a message template, the label for this group changes to Commit.

OK
 

Click this buon to save the changes you have made to the message template that is open on the
active subtab. The subtab closes.
 

Cancel
 

Click this buon to abandon changes you have made to your message. The subtab closes and the
Home tab becomes the active subtab.
 

Undock
 

Click this buon to undock the message from its subtab and open it in its own window.
 

Console This group displays only when a message has been undocked.
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Group/Buon Description

   

Dock to Console
 

Click this buon to redock the message to the editor on its own subtab.
 

Save
 

The buons in this group commit changes to the database for the global templates as well as the
messages across all interfaces.
 

Save
 

Click this buon to commit pending changes to the database and keep the editor open.
 
This buon is not available from an undocked message.
 

Save and Close
 

Click this buon to commit pending changes to the database and close the Message Templates editor.
 
This buon is not available from an undocked message.
 

Deploy
 

Deploy All
 

Click this buon to deploy the entire set of messages as well as the global templates across all
interfaces at the same time.
 
This buon is not available from an undocked message.
 

Note:  You must save after clicking the Deploy All buon to commit your changes to the
database.

Document
 

Edit
 

This buon, selected by default, lets you edit the message.
 

Live
 

Click this buon to view the most recently deployed version of the message.
 

Note:  Before you click the Deploy buon, the Live buon displays the active version that has
been saved and is live on your site. After you have clicked the Deploy buon, the version you
are editing displays. However, it has yet to be commied to the database.

Actions
 

Deploy
 

Click this buon to deploy the working version of your message.
 

Note:  You must click the Save buon on the message templates ribbon to commit your
deployed version to the database. After you save, your message will be active.

Restore
 

Click this buon to revert to the default system message.
 

Template
 

Click this buon to remove the global template content from the message. By default, the global
template is applied to all messages. Click it again to apply the global template to the message.
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Group/Buon Description

Proof
 

Click this buon to send a proof email to your content reviewers.
 

Note:  This buon sends the most recently saved version of the message. Therefore, to send
a proof of the version you are currently editing, you must click the OK buon on the message
ribbon and then Save on the message templates ribbon.

Proong
 

Spelling
 

Click this buon to spell check the message.
 

Show
 

Audit Log
 

Click this buon to view a history of changes made to the message.
 

Other
 

Info
 

Hover over this buon to see the message name and ID and the document ID associated with the
message.
 

Format Messages  
By default, all Oracle Service Cloud notications and emails are enabled and sent in multipart format, which includes
text and HTML versions of the same message in a single email. You can customize the format seings from the
Message Templates editor.

You can disable most messages and you can specify the format as text only. The version that displays to recipients is
ultimately determined by their mail client seings, but most mail clients display the HTML version by default.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Message Templates.

The Message Templates editor opens.
3. Select the interface you want to customize.

By default, the categories for administrator notications display on the right.
4. Click the appropriate buon on the ribbon Show group.

The categories for the message type (administrator notications, administrator emails, or contact emails)
display on the right.

5. Click the arrow to the left of the category to see the individual notications or emails associated with the
category.
Descriptions of each message as well as Last Deployed and Last Updated labels are listed under the category.
Both labels show the date and time the latest deployment and edit was made. If a message has been edited
but has not been deployed or if a deployment has not been commied to the database, the labels display
“Pending...” instead of the date and time.

6. To disable any of the messages, clear the Send check box next to the message. By default, all messages are
enabled.
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Note:  Messages that do not have a Send check box cannot be disabled because they support
essential functions.

7. To send the message as text, clear the HTML check box next to the message to be sent. By default, all
messages are sent in multipart format.
Messages that do not have an HTML check box are console-only notications and are not sent by email.

8. Click Save.

How Message Editing Works  
When you open a message to edit, the system maintains the active message while you edit a copy on the message
window. Your changes are not commied until you deploy and save them. This prevents any disruption in automatic
notications and emails during the editing process.

Because you are making edits to a copy of your message, the active content on your site is not aected until you are
condent in your changes and ready to deploy them. In case you make any accidental changes while editing, you can
restore your message by reverting to the original system default message at any time.

You can also view your active content so that you can copy and paste it into the version you are working on. For
instance, suppose you have made changes to your edited version and then want to go back to some of the elements
used in your active version. This feature lets you see a read-only version of the active content that you can copy and
paste into your working message.

Tip:  Remember to use the global template to apply your organization’s branding across all your messages.
See How You Customize the Global Template.

Edit a Message  
Your individual messages can be edited using the Message Templates editor.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Message Templates.

The Message Templates editor opens.
3. Select the interface you want to customize.

By default, the categories for administrator notications display on the right.
4. Click the appropriate buon on the ribbon Show group.

The categories for the message type (administrator notications, administrator emails, contact emails, or print
templates) display on the right.

5. Click the arrow to the left of the category to see the individual notications or emails associated with the
category.

6. Click Edit to the right of the HTML check box for the message you want to customize.
The message opens on a subtab and becomes the active subtab.

7. To edit the subject of the message, enter in the Subject eld.
For the best practice on creating eective subject lines, see Ensuring that contacts read your message.

8. To edit a merge eld in the subject, double-click the merge eld. See Insert a Text Merge Field.
9. To add a merge eld in the subject, click the Merge Field icon (to the right of the Subject eld) and select the

eld.
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Tip:  You can add up to 5 merge elds to your subject line with a maximum of 400 total characters.
However, remember that the best subject lines are simple, descriptive, and to the point. Also keep
in mind that email clients have their own limits on the maximum number of characters allowed in
subject lines. Being aware of these limits will help you determine the best subject line length for your
message.You cannot add merge elds to the subject of print templates or any of the forward-type
messages.

10. To add conditional subject lines to your message, click Advanced to the right of the Merge Field icon next to
the Subject eld and see Add a Conditional Subject Line.

11. Enter in the content placeholder (which is designated by the area inside the red box), and edit the message
using the hyperlinks, buons, dynamic content, and other features available on the HTML editor. See How You
Add HTML in Design Mode.

12. To view your most recently deployed content, click Live.
13. To revert to the system default message, click Restore.
14. To remove the global template from your message, click Template. If you click Template again, the global

template is reapplied to your message.
15. To spell check your content, click Spelling.
16. To preview your message, click the Preview tab at the boom of the HTML editor.
17. To see how your dynamic content displays, either by incident or contact, click the Search icon next to the

Preview Incident or Preview Contact eld.
The Search window opens where you can search for an incident or a contact to use when the message is
previewed on the Preview tab.

18. To send your edited message to another sta member for review, click Proof on the ribbon.
19. Click OK on the ribbon to save your edits and close the message.

At this point, your changes are not active because they have not been deployed or commied to the database.
See How You Deploy the Global Template.

Add a Conditional Subject Line  
You can personalize your email subject lines to tailor your message to dierent audiences with advanced subject
editing.

For example, you can change the subject line dynamically based on characteristics such as product, category, or custom
eld. In addition to the default subject line, you can add up to ten conditional subject lines to each message template.

List your additional subjects in order of importance because the rst one that matches will dene the subject line of the
message. If no conditions are met, the default subject line is used. (The default subject line will always be listed last.)

Note:  There are certain message templates that do not contain a subject line, such as those that forward
emails and print templates as well as the Survey Proof and Send Quote templates. Therefore, you cannot add
conditional subject lines to these messages.

1. From an open message template, click Advanced to the right of the Merge Field icon next to the Subject eld.

The Advanced Subject window opens.

Tip:  In addition to the default subject line, you can add up to ten conditional subject lines (for a total
of eleven) to each message template.

2. Click Add Subject.
The Subject Condition window opens.

3. Select the appropriate option for the type of condition you are adding.
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The available options are context-sensitive and depend on the type of message template you are editing.
Options can include Associated Contact, Recipient Prole, or Associated Record.

4. Select a segment, prole, or record type for the condition. When dening an associated record condition, you
will also need to dene an operator type and value.
Notice how the Title eld populates based on your selection. This eld populates only if you have not already
typed a title.

5. To change the title populated in the previous step, enter the title as you want it to appear in the Title eld.
6. Click OK to insert the subject.

Each new subject line is added above the default subject line.
7. To add another subject line, repeat the applicable steps starting at step 2.
8. To edit the subject line so that it reads the way you want it to, remove the default subject line from the eld in

the Subject column and enter the subject the way you want it to display to your customers.
9. To add merge elds to your additional subject lines, click the Merge Field icon next to the Subject eld. See

Insert a Text Merge Field.
You can add up to ve merge elds to your subject line with a maximum of 400 total characters.

10. To edit any merge elds, right-click the merge eld and select Merge Field Properties.
11. To edit a condition, click Edit in the Actions column and make any necessary changes to your condition.
12. To remove a condition, click Remove in the Actions column.
13. To reorder your additional subject lines, select the subject line you want to move and click the up or down arrow

next to the Action column.
The default subject is always last. Therefore, you need to have more than two additional subject lines dened
for the up and down arrows to be available.

14. To preview your subject lines, click the Preview tab.

Tip:  This is a great way to eciently test your default subject line and any advanced subjects without
the hassle of manually sending proof emails to yourself. Simply preview by applying the appropriate
record that will be used by each subject.

15. Click OK.

The Subject eld is now labeled Conditional Subject and is uneditable. After you add conditional subject lines to your
message, you must use the advanced editing feature to make changes.

Proof Messages  
When you are nished editing your message, you can send a proof to key sta for feedback on your design. For
instance, you may need your legal department to review language or your marketing department to review branding.

You can also customize your proof for a specic incident or contact to ensure that your dynamic content works the way
you intend it to.

Note:  This feature sends the most recently saved version of your message. Therefore, you must save your
edits to send a proof of the message you are working on.

Save works dierently depending on whether you are working from a subtab or an undocked message. Therefore, the
procedures dier slightly.

Send a Proof Message from a Subtab  
When you are nished editing your message, it’s a good idea to send a proof to key sta for feedback on your design.
For instance, you may need your legal department to review your language or your marketing department to review
your branding.

356



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Save works dierently depending on whether you are working from a subtab or an undocked message. Therefore, the
procedures dier slightly. If you are sending a proof message from an undocked message, see Send a Proof Message
from an Undocked Message.

Note:  This feature sends the most recently saved version of your message. Therefore, you must save your
edits to send a proof of the message you are working on.

1. Click the subtab for the message you want to send and then click Save on the ribbon.
2. Click Proof.

A message tells you to save and reopen your message. However, because you have already saved, you can
continue with step 3.

3. Click OK.
The Send Message Proof window opens.

4. Enter the email addresses of your reviewers in the address elds or click one of the buons to select reviewers
from a list.

5. To include any comments you want to appear in the message, enter them in the Comment text box.
6. To customize your proof message so that your reviewers can see your dynamic content, click the Search icon

next to the Customize Proof eld on the boom of the window. Depending on the message you are editing,
either the Incident Search window or the Contact Search window opens.

a. To customize your proof message by incident, enter the incident reference number in the Reference
# eld and click Search. The Incident Search window closes and the reference number populates the
Customize Proof eld on the Send Message Proof window.

Tip:  You can also enter part of a reference number in the Reference # eld. A list of incidents
that match your search criteria displays in the grid below the Reference # eld. You can then
select a reference number and click the Select buon. The Incident Search window closes and
the reference number you selected populates the Customize Proof eld on the Send Message
Proof window.

b. To customize your proof message by contact record, enter your search criteria in one or more of the
available elds and click Search. A list of contacts that match your search criteria displays in the grid
below the search criteria elds. You can then select a contact and click Select.
The Contact Search window closes and the contact name you selected populates the Customize Proof
eld on the Send Message Proof window.

7. Click Send.

Send a Proof Message from an Undocked Message  
When you are nished editing your message, it’s a good idea to send a proof to key sta for feedback on your design.
For instance, you may need your legal department to review your language or your marketing department to review
your branding.

Save works dierently depending on whether you are working from a subtab or an undocked message. Therefore, the
procedures dier slightly. If you are sending a proof message from a subtab, see Send a Proof Message from a Subtab.

Note:  This feature sends the most recently saved version of your message. Therefore, you must save your
edits to send a proof of the message you are working on.

1. Click OK on the message ribbon.
Your message closes.
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Note:  Because the system sends the most recently saved version of your message and there is no
Save buon on the message ribbon, you must save your edits from the message templates ribbon in
order to send a proof of the message you are working on.

2. Click Save on the message templates ribbon.
3. Click Edit to the right of the HTML check box for the message you were editing.

The message opens on a subtab.
4. Click Proof.

The Send Message Proof window opens.
5. Enter the email addresses of your reviewers in the address elds or click one of the buons to select reviewers

from a list.
6. To include any comments you want to appear in the message, enter them in the Comment text box.
7. To customize your proof message so that your reviewers can see your dynamic content, click the Search icon

next to the Customize Proof eld on the boom of the window. Depending on the message you are editing,
either the Incident Search window or the Contact Search window opens.

a. To customize your proof message by incident, enter the incident reference number in the Reference
# eld and click Search. The Incident Search window closes and the reference number populates the
Customize Proof eld on the Send Message Proof window.

Tip:  You can also enter part of a reference number in the Reference # eld. A list of incidents
that match your search criteria displays in the grid below the Reference # eld. You can then
select a reference number and click the Select buon. The Incident Search window closes and
the reference number you selected populates the Customize Proof eld on the Send Message
Proof window.

b. To customize your proof message by contact record, enter your search criteria in one or more of the
available elds and click Search. A list of contacts that match your search criteria displays in the grid
below the search criteria elds. You can then select a contact and click Select.
The Contact Search window closes and the contact name you selected populates the Customize Proof
eld on the Send Message Proof window.

8. Click Send.

How You Deploy Messages  
To make your changes live, you must deploy and then commit your changes to the database.

There are three ways to deploy your messages.

• Click Deploy next to the message on the Home subtab.

• Click the Deploy buon on the message ribbon.

• Click the Deploy All buon on the message templates ribbon or the message ribbon.

This image shows the Deploy All buon on the message templates ribbon as well as the Deploy link next to the
messages on the Home subtab.
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This image shows the Deploy All buon and the Deploy buon on the message ribbon.

The order in which you choose to deploy depends on several things. If you are editing only one message, it’s probably
most ecient to click Deploy on the message ribbon as soon as you have nished making your changes.

If you are editing several messages, you can save your changes as you make them by clicking the Save buon on the
message ribbon. When you are nished with all of your message edits, you can click the Deploy All buon, and then
click the Save buon on the ribbon to commit all of your messages at the same time. Deploying all also applies to the
global templates (across all interfaces) for all your messages unless you have chosen to remove it within your individual
messages. This method eliminates the need for you to respond to the conrmation message that opens each time you
deploy from an individual message.

Tip:  You can always go back to the system default message by opening your message and clicking Restore on
the ribbon.

Deploy One Message  
You must deploy your message to make your changes active.

1. Click Deploy on the ribbon.
A message asks you to conrm your decision to deploy.

2. Click OK to continue.
3. Click OK on the ribbon.
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The subtab or editor closes depending on whether you are working from a docked or undocked message.
4. Click Save on the ribbon to commit your deployment.

Your deployed version is now active.

Deploy Multiple Messages at the Same Time  
You must deploy your messages to make your changes active.

This procedure assumes you have edited more than one message and have saved your changes.
1. Click Deploy All buon on the ribbon.

A message asks you to conrm your decision to deploy all messages as well as the global template.

Note:  Deploy All applies to the global templates and messages across all interfaces.

2. Click OK to conrm.
3. Click Save on the ribbon to commit all your deployments to the database.

Your deployed versions are now active and all of the message labels display the same date and time.

Incident Response Tracking  
Incident response tracking lets you see how customers react to interactions they have with your agents. This helps
improve customer support because you can see if your customers are using the information you send them.

For instance, suppose you are sending 500 emails a week. Incident response tracking can show you how many of those
emails are opened and how many links are clicked that result in a visit to your customer portal.

In addition, incident response tracking is eective in helping you evaluate aspects of your customer experience solution,
including the quality of your agent responses. Not only can you see the actions contacts take before submiing an
incident, but you can also track what happens after submiing an incident. For example, suppose your agent sends an
answer link in response to a contact’s question. If the contact clicks the link, you can see every action the contact takes
on your customer portal.

Simply stated, message templates track customer-facing incident responses, which lets you see activity related to the
following contact email messages.

• Question Receipt—This email is sent to contacts to conrm the receipt of their question from the Ask a
Question page, an email, or a chat session.

• Rule Email—This email is sent to a contact when the Send Response action is triggered by a business rule.

• Incident Closed—This email is sent to a contact when an incident status changes to Solved.

• Incident Solved—This email is sent to a contact when a sta member responds to the incident and the incident
status is Solved.

• Incident Waiting—This email is sent to a contact when a sta member responds to the incident and the incident
status is Waiting.

• Incident Unresolved—This email is sent to a contact when a sta member responds to the incident and the
incident status is Unresolved.

You can track how often these incident response emails are viewed as well as how customers use the information that
you provide in your response, such as viewed answers, clicked links, and customer portal pages that were accessed.
Only unique views and clicks are tracked so you can be condent that your statistics are accurate. This also helps to
keep stored data manageable.

360



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

You can also use tracked links in your messages to automatically track your hyperlinks. Before you can insert tracked
links into your message content, you need to add them to your system. For complete details and procedures on adding
tracked links to your system, and then inserting tracked links from the HTML editor, see Add a Tracked Link and Insert a
Tracked Link.

Incident response tracking data is accessed through standard reports located in public reports which are accessed either
from the Reports Explorer or from the Customize List window (accessed by clicking the Gear icon on your navigation
list). Statistics used for this report are stored in the Message Transactions (message_trans) table. For a description of
the information logged in the Message Transactions table, see the Data Dictionary located on the navigation pane (
Conguration > Database > Data Dictionary ).

Note:  The conguration seing MESSAGE_TEMPLATES_PURGE_DAYS denes how long data in the Message
Transactions (message_trans) table is stored. By default, data is removed after 400 days. This ensures
that your database tables stay at a manageable size. You can change the value of this seing using the
Conguration Seings editor, accessed from the navigation pane ( Conguration > Site Conguration >
Conguration Seings . From the Conguration Seings editor the seing is located in RightNow Common/
Message Templates/General. See How You Customize Conguration Seings.

• Incident Message Statistics—This report provides statistics comparing the number of incident responses
sent and the number that contacts viewed over time. (Public Reports/Service/Incident Reports/Incident
Activity)

• Incident Message Transactions—This report was designed to be added to an incident workspace. It provides
statistics on runtime activity, such as message content, date and time of incident creation, message type
(answer or tracked link), and if a customer portal session resulted from any contact interaction. (Public
Reports/Service/Views/Service/Editor Reports - Service)

• Incident Message Web Visit Details—This report maps the incident that triggers the email as well as the
customer portal session that results from a contact clicking a link in an email. It is inherently related to the
Incident Message Transactions report because the runtime lter it requires is a web visit ID. (Public Reports/
Service/Views/Service/Editor Reports - Service)

Related Topics
• How You View Reports

• How You Search in Reports

Examples of Message Templates  
This set of examples includes scenarios where message templates can be used to accomplish more advanced and
specic needs.

• Dene Conditional Content Based on Message Thread Count

• When to Use Case Sections vs. Conditional Sections

• Apply Product-Specic Logos

Dene Conditional Content Based on Message Thread Count  
In addition to limiting the thread count on your incident thread properties, this example shows you how to display
content based on the number of threads that are included within the sent message.
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For example, if you set your message thread count to be greater than ten, when the number of threads included with
the message exceeds ten, you could create a conditional section based on this message thread count threshold with
content telling your customers to call the customer support team for a faster resolution.

Note:  Keep in mind that if you have already limited the thread count in your incident thread properties, this
also aects the number of threads that display. For example, if you limit your thread count to three, you’ll
need to make sure any conditional sections based on this message thread count do not exceed three. In other
words, if you create a conditional section based on four threads and you limit the number of message threads
to three, the condition will never match because the incident thread count limit will keep the message from
reaching the value of four threads. See Insert an Incident Thread.

1. Add a conditional section or a case section to your message template.
2. Select Associated Record.
3. Expand the Special Fields folder and select Message Thread Count.
4. Select an operator from the Operator drop-down menu.
5. Enter a value for the operator in the Value eld.
6. Click OK to add the logic to your conditional content.

At this point, you’ve dened only the If condition. Next, you need to dene the content that will display.
7. Place your cursor inside the condition you just added and enter the content you want to display when the

condition value is matched.
The following image shows the Case Section with the conditional content “Please call us to resolve your issue.” set to
display when the message thread count is greater than ten.

When to Use Case Sections vs. Conditional Sections  
Understanding when to use a case section instead of an independent conditional section is important in making your
content is as eective as it can possibly be. These examples describe scenarios that put the best option to use.

Understanding the dierence between case sections and independent conditional sections is essential to be sure your
conditional content works the way you expect. Simply stated, a case section shows one, and only one, condition out of
a group of conditions. This makes case statements a great tool for seing up OR statements. In contrast, a conditional
section can be used to show one or more conditions at the same time. Which one to use depends entirely on your goal.

Show or hide one section—Let's say you want to show a toll-free support number to customers in the U.S. In a straight-
forward scenario such as this, when the answer is either “yes” or “no,” a simple conditional section does the job. Just
dene the content you want to display for your single condition and when it matches, your content displays. When the
condition does not match, nothing displays.

Show more than one section—In another scenario, you might want to show a toll-free support number to U.S.
customers and a list of store locations to customers in Colorado. You can do this by dening two conditional sections—
one showing the phone number based on country and another showing locations based on state. For customers who
live in Colorado, both the toll-free number and the store locations will display.
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Show 1 of 2 sections—If you would rather list only store locations for customers in Colorado and show a toll-free support
number to other customers, but you don’t want to show both, this is where a case section comes in handy. In your
conditional section, list the locations and dene your condition based on state. In the default section, dene the toll-free
number. For customers with a Colorado address, only the locations display. For all other customers, the phone number
displays.

Show 1 of 3 sections—Building on the previous scenario, let’s dene a case section with multiple conditions where your
default section will show an international number to customers living outside of the U.S. Again, you want to show only
one condition to each segment of customers. Base the rst condition on the state of Colorado, the second condition on
the country being the U.S., and dene the international number in the default section. Remember, in a case section, the
rst condition that matches is the only one that displays.

In action, here’s how the last scenario plays out.

• If the contact record indicates a Colorado address, the store locations display.

• If the contact record indicates a U.S. address outside of Colorado, the second condition matches and the toll-
free U.S. number displays.

• If the contact record has no address or if it does not match Colorado or U.S., the international number you
dened for the default section displays.

Note:  If you do not dene the default section and the rst two conditions do not match any criteria, nothing
displays.

Apply Product-Specic Logos  
This example shows you how to use case sections and conditional sections to brand your message templates based on
products within the same interface.

For instance, say you have one interface that represents two separate brands—each one with its own logo. You’ve
already dened each brand as its own product. Now, you want your customer-facing message templates to display
the correct logo depending on which product the message refers to. If you had a separate interface for each brand, the
global template could be used to apply the same branding across the entire interface. However, since you have only
one interface, the global template will not work because it is applied across all messages per interface. Therefore, you
must remove the global template from the individual message templates and then use case and conditional sections to
display the appropriate logo based on product.

Most likely, you’ll want to focus this eort on the customer-facing, incident-related message templates, although any of
the messages found in the Contact Emails message type should be considered. In some cases, taking a more generic
approach in which the global template could be used might make more sense.

1. From an open message template, click Template on the ribbon. This action removes the global template from
the message template.

2. Insert your cursor where you want your logo to display and click Case Section in the toolbox.
A case section is inserted in the message template.

3. Select the conditional section inside the case section, right-click, and select Conditional Section Properties.
The Conditional Section window opens.

a. Select Associated Record.
b. In the Record section, expand the Incident Fields folder and select Product.
c. Select Equals from the Operator  drop-down menu.
d. Select the product you want associated with this conditional section from the Value drop-down menu.
e. Click OK.

4. Right-click inside the case section and select Add Conditional Section.
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5. Repeat steps 3a-3d to dene the condition for your second product.
6. Click inside the rst conditional section and click Image in the toolbox. The Image Editor window opens.

a. Enter the URL where the logo you want to display for this product is located.
b. Click OK.

7. Repeat step 6 for the second conditional section.

Note:  Leave the Default section blank (do not delete it). This way, if the product is unknown, then no
image will display.

8. Click Save.
9. Repeat steps 1-8 for each message template you want to apply dierent logos to.

Tip:  After you dene the rst case section, you can easily select the case section, copy it, and then
paste it into your other message templates.

At this point, your changes are not active because they have not been deployed or commied to the database. See How
You Deploy the Global Template.

Related Topics
• Insert an Image

• Insert a Conditional Section

Data Import  

Overview of Data Import  
With data import features, you can add new contacts, answers, assets, incidents, organizations, and custom objects to
your Oracle database from a data le.

For example, you can import lists of prospects or recently acquired customers into your knowledge base as new
contacts or update existing answers to keep your database synchronized with an external knowledge base.

You can also import conguration seing values and message base text values that you have edited from the
Conguration Seings and Message Bases editors. For example, suppose you want to create a site in another language
and need to make changes to your text labels. You can create a CSV (comma-separated value) le that includes all of
your message base text and do a global search and replace. Then, using the Data Import Wizard, import your le and
your changes will be made to the message bases. For complete details and procedures about the Conguration Seings
and Message Bases editors, see Overview of Site Conguration.

Additionally, you can import custom conguration seing and message base metadata into other sites. This can save
time, especially when you have large numbers of custom seings and message bases.

Oracle Service Cloud provides the following import features.

• Data Import Wizard—Use the powerful import wizard to map the data le to columns in the Oracle database
and prescan the le for problems, such as duplicate records or invalid email addresses. After an import, you can
run external events or business rules on the imported records. You can also add contacts to a mailing list or use
them to initiate a campaign.

• Data import templates—For imports that you want to perform more than once, you can create column mapping
templates that can be selected when importing data with the wizard.
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• Data imports reporting—View the Data Imports report to track information about past imports.

Note:  In order to access the Data Import Wizard and template editor, sta members must have the Data
Import permission in their prole. A sta member with this prole permission can import any of the supported
record types, even if the sta member’s only responsibility is to import contact data for marketing purposes.
See Administration Permissions.

How Data Import Works  
To import data, you need a data le containing the information you want to import. The most commonly used le
format is CSV (comma-separated value), but delimiters other than commas can also be specied.

In addition to importing data to the primary table of a supported record type, you can map data to certain database
elds in associated tables. For example, when importing data to the Incidents (incidents) table, you can map columns to
the Threads (threads) table to create customer proxy or note threads associated with each incident.

The data import features are designed to import specic data sets into the knowledge base, not to support full data
migrations. You should be aware of the following restrictions when preparing an import.

• If Oracle RightNow Cloud Service (Service) is disabled, answer, asset, and incident record types are not available
for import.

• The maximum number of elds that can be mapped is 50.

• Associated table mapping is applied only when the import creates new records. Such mapping is ignored when
existing records are updated by the import.

• Only certain values can be mapped to the associated tables of a record. For example, you cannot map a value
for the threads.entered eld. This value is set to the date and time the import occurred.

• The Products and Categories elds are not available for mapping to answers. If you want to associate imported
answers with products or categories, you must update them manually from within Oracle Service Cloud.

Import Data  
You can add new contacts, answers, assets, incidents, organizations, and custom objects to your Oracle database by
using the Data Import Wizard.

1. Click Conguration on the navigation pane.
2. Expand Database, and then double-click Data Import Wizard.

The Data Import Wizard opens.
3. Enter eld information.

Field/Item Description

Data Record Type Click this drop-down menu to select the type of records you want to import.

Answer Select this option to designate answer data as the type of record you want to import.

Asset Select this option to designate assets data as the type of record you want to import.
Currency elds are not supported. For example, the Price eld cannot be imported.
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Field/Item Description

Cong Base Entry Select this option to designate conguration seing data as the type of record you
want to import. For example, you can create a CSV le that includes your custom
conguration seings and then import those seings to your other sites.
The following elds are required in the Column in File and Field columns for mapping
to work. Other columns may also be required depending on the data types of the
conguration seings you are importing.
 
Key = Conguration Entry Key (entry_key)
 
Type = Conguration Entry Base Type (type)
 
Data Type = Conguration Entry Data Type (data_type)
 
Default Value = Default Conguration Value (default_value)
 
Prerequisite: You must create a conguration base entry before you can create a
conguration base value.
 

Cong Base Value Select this option to designate conguration seing value data as the type of record you
want to import. Conguration base value records are essentially the “child” records of
conguration base entries.
The following elds are required in the Column in File and Field columns for mapping
to work. Other columns may also be required depending on the data types of the
conguration seings you are importing.
 
ID = Conguration Entry ID (congbase_entry_id)
 
Key = Conguration Base ID (congbase_id)
 
Value = Conguration Value (value)
 
Prerequisite: You cannot create a conguration base value unless you have a
conguration base entry to map it to. Therefore, you must create a conguration base
entry before you can create a conguration base value.
 

Contact Select this option to designate contact data as the type of record you want to import.
This is the default record type.
 

Incident Select this option to designate incident data as the type of record you want to import.

Message Base Entry Select this option to designate message base data as the type of record you want to
import. For example, you can create a CSV le that includes your custom message bases
and then import the le to your other sites.
The following elds are required in the Column in File and Field columns for mapping to
work.
 
Key = Message Base Text Key (entry_key)
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Field/Item Description

 
Type = Message Base Entries Type (type)
 
Maximum Length = Message Base Text Maximum Length (max_length)
 
Text = Text (text)
 
Prerequisite: You must create a message base entry before you can create message base
text to go with it.
 

Message Base Text Select this option to designate message base text data as the type of record you want to
import. Message base text records are essentially the “child” records of message base
entries.
The following elds are required in the Column in File and Field columns for mapping to
work.
 
ID = Message Base Entry ID (msgbase_entry_id)
 
Message Base = Message Base ID (msgbase_id)
 
Custom Text = Message Base Custom Text (custom_text)
 
Prerequisite: You cannot create a message base text unless you have a message base
entry to map it to. Therefore, you must create a message base entry before you can
create a message base text.
 

Organization Select this option to designate organization data as the type of record you want to
import.

Custom Object Select this option to designate custom object data as the type of record you want to
import.
Custom objects must be enabled for this option to display. To enable custom objects,
 contact your Oracle account manager.
 

*Data File Click Browse to the right of the eld to access the le containing the data you want to
import.
Windows/MS-DOS format is the only supported CSV le type.
 
The maximum number of elds that can be mapped is 50.
 

Header Location Click this drop-down menu to select the location of the column headers that identify the
contents of the data le.

First Line of Data File Select this option if the column headers are located in the rst row of the data le.

No Headers Specied Select this option if there are no column headers dened for the data le.

367



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field/Item Description

Header File Select this option if the column headers are located in a separate CSV le.
The header le cannot contain fewer columns than the data le.
 

*Import Header File Click Browse to the right of the eld to access the CSV le containing your header
information. This eld is active when Header File is selected from the Header Location
drop-down menu.

Staging Directory Click Browse to the right of the eld to select a location for staging the good and bad
output les that are generated during the data prescan process. By default, the location
is C:/Documents and Seings/<username>/My Documents/My Imports/YYYY-MM-
DD-#.
The staging directory can be set to a local directory on your workstation or a shared
network drive.
 

Duplicate Records Click this drop-down menu and select the method used to handle records in cases
where the data le and database contain duplicate records. See Duplicate Record
Handling for Data Imports.

Keep Original Data Select this option to prevent updating the database where duplicates occur. Duplicate
records are not recorded as errors.

Note:  For optimal performance when adding existing contacts to a contact
list, we recommend that you select this option when using the Insert Into
Contact List drop-down menu (as described in this table).

If you are importing custom conguration seing or message base metadata, you must
select this option or the data import will return errors.
 

Update Existing Data Select this option to update the database with data from the data le where duplicates
occur. Duplicate records are not recorded as errors.

Record Error Select this option to prevent updating of the database where duplicates occur and to
record duplicates as errors.

Run Campaign Click this drop-down menu to select a campaign entry point for imported contact
records. See Overview of Campaigns.
This option is available only when importing contacts.
 

Insert Into Contact List Click this drop-down menu and select a list to associate all imported contact records
with a contact list. To create a new contact list to associate with the imported records,
click New Contact List. See Add a Contact List.
This option is available only when importing contacts.
 

Note:  For optimal performance, be sure to select the Keep Original Data
option in the Duplicate Records drop-down menu when using this option. See
the Keep Original Data description in this table.
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Field/Item Description

Click this icon (signied by a plus sign and located to the right of the Insert Into Contact
List drop-down menu) to create a new contact list.

*Delimiter Enter the character used to separate columns in the data le. The default delimiter is a
comma.
The tab character is not a supported delimiter.
 

Stop Import on Error Select this check box to prevent any more records from being imported if an error is
found during the import process. If this check box is not selected, the import continues
despite any error, and only records without errors are imported. The check box is cleared
by default.

Run External Events Select this check box if you want external events to run against the data you are
importing. The check box is cleared by default.

Run Workow Rules Select this check box if you want business rules to run against the data you are
importing. The check box is selected by default.

4. Click Next.
The content pane displays elds for dening column mapping and duplicate criteria as well as a preview of the
records in the data le.

5. Enter eld information.

Field/Icon Description

File Encoding Click this drop-down menu to select the encoding type of the data le. The default
encoding type is UTF8.

Select Template Click this drop-down menu to select a previously saved template to use for mapping the
data le columns to the database. See Add or Edit a Data Import Template.
This menu lists only templates for the record type you are importing.
 

*Name Enter a template name and click Save As Template on the ribbon to save the current
column mapping as a template. Click Clear to clear the eld contents. The default
delimiter is a comma.
The template name must be unique for the record type, and the tab character is not a
supported delimiter.
 

Column Mappings This section denes how columns in the data le are mapped to elds in the database.

Add Click this icon to create a new row in the column mapping grid.

Remove Click this icon to remove a selected row from the mapping grid.

Column in File Click the drop-down menu to select the column name specied in the data le or header
le, or the column number if no header was specied.
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Field/Icon Description

Field For each data column that you want to import, click the drop-down menu and select
the database eld that you want to map the column to. The data from the column is
inserted into the specied database eld. If you have specied column headers that
exactly match the database eld names (such as rst_name), the system aempts
to automap the eld for you. If the data le contains a column that you do not
want to insert into your database, leave this eld set to No Value. For information
about database elds, see the Data Dictionary located on the navigation pane (
Conguration > Database > Data Dictionary ).

Tip:  If you map a column to ma_org_name, the Data Import Wizard populates
the eld with the text value from the data le. If you want to associate a
contact with an organization, you can either map the org_id to Organization
ID or map the name of the organization to Organization ID. The Data Import
Wizard looks up the organization and associates the name to the correct
organization. If the lookup fails, an error occurs.

Ignore on Update Select this check box if you want this column to be inserted into the database for new
records, but do not want the column updated for existing records.

Note:  This option has no eect unless you select Keep Original Data from the
Duplicate Records drop-down menu.

Default Value Enter the default value to be inserted when an imported record does not contain data
for the column.

6. To map a column to a table associated with a new import record type, click Add in the section corresponding to
the associated table.
Table mapping is available only for new records.

◦ Notes—Maps columns to the Notes (notes) table for answer, contact, and organization imports.
Supported elds include chan_id and text.

◦ Threads—Maps columns to the Threads (threads) table for incident imports. Supported elds include
chan_id, seq, note, and entry_type.

◦ Addresses—Maps columns to the Organization Addresses (org_addrs) table for organization imports.
Supported elds include oat_id, city, country_id, postal_code, prov_id, and street.

For information about database elds, see the Data Dictionary located on the navigation pane  Conguration >
Database > Data Dictionary .

Be aware of the following restrictions when preparing an import.

◦ Associated table mapping is applied only when the import creates new records. Such mapping is ignored
when existing records are updated by the import.

◦ Only certain values can be mapped to the associated tables of a record. For example, you cannot map a
value for the threads.entered eld. This value is set to the date and time the import occurred.

7. Enter eld information to map a column to a table associated with a new import record type.
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Field/Icon Description

Add Click this icon to create a new entry in the mapping grid.

Remove Click this icon to remove an entry from the mapping grid.

Column in File Click the drop-down menu to select the column name specied in the data le or header
le, or the column number if no header was specied.

Field This eld displays the database eld that you can map a column to. The data from the
column is inserted into the specied database eld.

Default Value Enter the default value to be inserted when an imported record does not contain data
for the column.

8. To dene custom criteria used to identify duplicate records, clear the Use Default check box.
9. Click Next.

The system prescans the data le for errors (such as incorrectly formaed email addresses) and the content
pane displays the results.

Note:  If the data le is signicantly large, the prescan and import processes can take a considerable
amount of time. The Data Import Wizard supports up to one million records per import. If the data le
exceeds this size, you must split the data into multiple les of a million records or less.

10. Review the sample output in the good records preview to conrm that your le is mapped properly.

The Summary section of the results page displays the number of records to be inserted, updated, ignored, and
added during the import process, as well as the number and types of errors returned during the prescan.

Other results include the prescan status as well counts and previews of good and bad records, as categorized by
the prescan process. The good records preview consists of a random sample of up to 10,000 records that were
found to be formaed correctly. The bad records preview consists of up to the rst 10,000 records that resulted
in an error.

For each record, the preview displays each mapped column, the data to be inserted, and the record row number
in the data le. The bad records also include an error description to assist with troubleshooting. See Data
Import Error Handling.

11. To enter a name for the import as it appears on the Data Imports report, enter the name in the Name eld. By
default, the import is given the name of the data le you are importing.

12. To see a full list of the good or bad records found during the scan process, click Open CSV File to open the list
in a CSV le.

13. To view a CSV le containing the good or bad records, click Open CSV File next to the good or bad record
counts.

14. To ignore errors returned by the prescan process and continue importing the records that did not return errors,
select the Ignore Errors check box beneath the bad record count.

Note:  If errors are reported for records that you want to include in the import, you must resolve the
errors before proceeding.

15. Click Next.
The data imports to the database.
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When the import starts, the content pane displays the real-time import status, a list of any errors found during
the import, and summary counts of records that were inserted, updated, ignored, added, or that experienced
errors.

Back and Next are unavailable during the import process.

16. To pause the import process after it starts, click Stop on the toolbar. Click Start to resume the import.
Any records listed as returning errors are not imported to the database. Also, if you close the wizard before the
import is nished, the import process ends prematurely and you must begin the procedure again to complete
the import.

When the import process is complete, the Import Status eld displays Import Complete.

All imported records are immediately available for use. Any additional processing that you specied on the initial screen
of the wizard (such as the running of a campaign, business rules, or external events) triggers automatically for the new
records as soon as they are imported.

Duplicate Record Handling for Data Imports  
The Duplicate Criteria section of the Data Import Wizard displays the criteria used to prevent instances of redundant
records, which can be especially helpful when importing contacts.

During the import process, elds listed in the criteria are compared with existing values in the primary record table in
search of duplicate records. When importing contacts, duplicate values in the email, email_alt1, and email_alt2 elds
of the data le are also detected. When a duplicate is found, action is taken as specied in the Duplicate Records drop-
down menu on the initial page of the wizard.

Duplicate criteria consists of a logical expression formaed as field_name={mapped column}, where mapped column is the
column number or header name. Multiple elds evaluate using Boolean logic.

The default expression varies based on the type of records imported and the columns mapped to the knowledge base.
The following elds are automatically included as default duplicate criteria whenever they are included in the mapping
grid.

• Email Address—When importing contacts, to simplify detection of redundant values in the primary and
secondary email address elds (email, email_alt1, and email_alt2), the expression references them together as
any_email. For example, any_email={1}.

• Contact ID, Organization ID, Incident ID, Answer ID—These elds are included as default criteria when importing
their primary record type. Because these elds are unique for every record, additional criteria would not
be more restrictive. For this reason, OR logic is used whenever they are added to the duplicate criteria. For
example, any_email={1} OR c_id={2}.

• First and Last Name—If email address sharing is enabled, first_name and last_name is included when importing
contacts. This narrows the criteria by permiing multiple contacts that share a common email address as long
as they have dierent rst or last names. For example, any_email={1} AND first_name={2} AND last_name={3}.

• Login—When importing contacts, this eld is included in the default criteria if it is mapped. For example,
login={1}.

• Organization Name—When importing organizations, this eld is required and is always included in the default
criteria. For example, name={1}.

• Reference #—When importing incidents, this eld is included in the default criteria if it is mapped. For example,
ref_no={1}.

• Key (conguration seing name)—When importing conguration base entries, these required elds are
included in the default criteria. For example, entry_key={Key}.
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• ID and Key—When importing conguration base values, these required elds are included in the default
criteria. For example, configbase_id={ID} AND configbase_entry_id={Key}.

• Key (message base name)—When importing message base entries, this required eld is included in the default
criteria. For example, entry_key={Key}.

For added exibility, you can dene custom criteria by clearing the Use Default check box and entering a logical
expression using any combination of mapped elds. For instance, if you want to avoid creating duplicate contacts
with the same last name (mapped to column 1) and user ID (mapped to column 2), you can enter last_name={1} AND
login={2}. If column headers are specied in the data le or header le, you can refer to them by header name instead,
such as last_name={Last Name} AND login={User ID}.

Note:  If you dene custom criteria that does not include the email eld, and email address sharing is not
enabled, records matching existing contacts create new contacts with a numerical value appended to the
email address. See Email Address Sharing.

When customizing duplicate criteria, supported Boolean operators and characters can be inserted by clicking the
buons above the Criteria eld or by simply entering them in the Criteria Field.

Data Import Error Handling  
If the Data Import Wizard prescan process returns errors, you can select the Ignore Errors check box to ignore them and
continue importing only those records without errors. However, if the prescan reveals errors involving records that you
need to import, you must resolve the errors in order to proceed.

You can do so by manually repairing the records in the data le and rerunning the wizard, or you can click the Back
buon to return to the column mapping page and either clear the mapping for columns that returned errors or map
them to another eld. However, if you want to import all the data as originally mapped, you need to repair the records in
the data le.

To make the task of repairing the data le simpler, the prescan result page displays the erroneous data along with row
numbers and error descriptions to help you locate each problem record in your original data le and correct the issue
that led to the error. To view the complete list of errors in a text editor or spreadsheet program, click the Open CSV File
buon next to the record count.

The CSV le can also be accessed locally from the staging directory dened on the initial screen of the wizard. For most
Windows operating systems, the default location is C:/Documents and Seings/<username>/My Documents/My
Imports/. For Windows 7, the default location is C:/users/<username>/My Documents/My Imports/.

The staging directory contains a subdirectory for each import with the naming convention <current date>-<import
aempt number> (for example, “2010-05-15-1”). The subdirectory of each import contains the following les.

• <data_le_name>.bad.csv  contains all records that returned an error during the prescan process.

• <data_le_name>.good.csv  contains all records that did not return an error.

• <data_le_name>.badaux.csv  and <data_le_name>.goodaux.csv  contain diagnostic information that can be
provided to support for troubleshooting errors.

After the data le is repaired, you can start the import procedure again and the errors that were addressed in the
previous prescreen process should no longer occur.

In rare instances, an error may occur during import that was not detected during the prescan process. If you selected
the Stop Import on Error check box on the initial screen of the wizard, the import status changes to Import Error and
the process stops to prevent further records from being imported. If the Stop Import on Error check box is cleared (the
default seing), the import continues despite any error and only records without errors are imported.
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Add or Edit a Data Import Template  
You can create data import templates for use in the Data Import Wizard. Templates let you skip some import wizard
steps, such as mapping columns to database les and customizing duplicate criteria, when performing imports of
multiple data les that have the same column ordering.

After a template is created, you can select it when mapping data eld columns through the Data Import Wizard. This can
be useful if you frequently import records from an external source where the data format does not change but the data
is more current.

Note:  Data import features are designed to import specic data sets into the knowledge base, not to support
full data migrations. For this reason, you should be aware of certain restrictions when preparing an import.

1. Click Conguration on the navigation pane.
2. Expand Database, and then double-click Data Import Templates.

The Data Import Templates tree displays on the content pane.
3. Do one of the following:

◦ To add a template, select a record type in the tree and click New on the ribbon to display the editor.

◦ To edit an existing template, click it in the tree.

The Data Import Templates editor opens. It consists of a set of elds for mapping columns to database elds in
primary and associated tables, dening criteria for detecting duplicate records, and viewing interface visibility
information for the template.

4. Enter eld information.

Field/Icon Description

*Name
 

Enter the name of the template.
 

Column Mappings
 

This section denes how columns in the data le are mapped to elds in the database.
 

Add
 

Click this icon to create a new row in the column mapping grid.
 

Remove
 

Click this icon to remove a selected row from the column mapping grid.
 

Column in File
 

The column number that the data le will be mapped to. The maximum allowed value is
9999.
 

Field
 

For each data column that you want to import, click the drop-down menu and select
the database eld that you want to map the column to. The data from the column
is inserted into the specied database eld. If the data le contains columns that
you do not want to insert into your database, leave this eld blank. For information
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Field/Icon Description

about database elds, see the Data Dictionary located on the navigation pane (
Conguration > Database > Data Dictionary ).
 

Tip:  If you map a column to ma_org_name, the Data Import Wizard populates
the eld with the text value from the data le. If you want to associate a
contact with an organization, you can either map the org_id to Organization
ID or map the name of the organization to Organization ID. The Data Import
Wizard looks up the organization and associates the name to the correct
organization. If the lookup fails, an error occurs.

Ignore on Update
 

Select this check box if you want this column to insert to the database for new records,
 but do not want the column updated for existing records.
 

Note:  This option has no eect if you selected Keep Original Data from the
Duplicate Records drop-down menu.

Default Value
 

Enter the default value to insert when an imported record does not contain data for the
column.
 

5. To map a column to a table associated with the import record type, click Add in the section corresponding to
the associated table.

◦ Notes—Maps columns to the Notes (notes) table for answer, contact, and organization imports.
Supported elds include chan_id and text.

◦ Threads—Maps columns to the Threads (threads) table for incident imports. Supported elds include
chan_id, seq, note, and entry_type.

◦ Addresses—Maps columns to the Organization Addresses (org_addrs) table for organization imports.
Supported elds include oat_id, city, country_id, postal_code, prov_id, and street.

Note:  For information about database elds, see the Data Dictionary located under Conguration >
Database.

6. Enter eld information.

Field/Icon Description

Add
 

Click this icon to create a new entry in the mapping grid.
 

Remove
 

Click this icon to remove an entry from the mapping grid.
 

Column in File
 

Enter the column number that the data le or header le will map to. The maximum
allowed value is 9999.
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Field/Icon Description

Field
 

This eld displays the database eld that you can map a column to. The data from the
column inserts to the specied database eld.
 

Default Value
 

Enter the default value to insert when an imported record does not contain data for the
column.
 

7. To dene custom criteria used to identify duplicate records, click the Criteria eld and see Duplicate Record
Handling for Data Imports.

8. To enter a dierent name for the template based on interface, select the Label value next to the interface name
in the Visibility section and enter the name. (This is helpful if your site has multiple interfaces of dierent
languages.) By default, each Label value is populated with the name of the template you dened in step 4.

9. Click Save.

Data Import History  
Occasionally, you may want to review information about previous imports to understand how imported records were
created in your site. Historical details about past imports are available in two locations, based on when the import was
performed.

Imports are tracked in the Data Imports report, located in Public Reports/Common/Site Administration/Data
Imports. The Data Imports report contains information such as the type of records imported, start and completion
dates and times, import le names, import status, and information about le locations and column mapping. The
statistics used for this report are stored in the Data Imports (data_imports) table and can also be accessed by creating a
custom report. For a description of the information logged in the Data Imports table, see the Data Dictionary located on
the navigation pane ( Conguration > Database > Data Dictionary ).

Related Topics
• Overview of Creating Basic Custom Reports

Element Manager on the Agent Browser UI  
Element Manager lets you automatically group, package, migrate, and deploy congurable components across Oracle
Service Cloud instances. You can easily migrate congurations from development, to test, and then to production
environments.

Element Manager lets you export and import reports, workspaces, workows, and dashboards.

Note:  Element Manager works only on the Agent Browser UI. If you try to access it from the Service Console, a
message tells you it is available only on the Agent Browser UI. For more information, see  Element Manager .
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SAML 2.0 Open Login  

Overview of SAML 2.0 Open Login  
Oracle Service Cloud supports SAML 2.0 single sign-on (SSO) integrations, which let your agents and customers log in
using credentials supplied by external identity providers (IdPs).

Agents can also use Oracle Service Cloud as an IdP to provide login credentials and authentication services to third-
party applications. This lets your agents seamlessly access these applications from the Service Console or Agent
Browser UI without being required to re-enter their credentials.

The procedures to implement your single sign-on conguration dier depending on what you want to accomplish.

• If you want your agents or customers to log in to Oracle Service Cloud using credentials from an external IdP,
see Single Sign-on Support in Oracle Service Cloud. Single logout is supported when using this conguration.

• If you want your agents to be able to access external applications from the Service Console or Agent Browser UI
without being asked for login credentials, see Log in to External Applications Using Oracle Service Cloud as the
Identity Provider.

Note:  This functionality is not available for customers.

Single Sign-on Support in Oracle Service Cloud  
Oracle Service Cloud includes single sign-on (SSO) support for agents working on the Service Console or Agent Browser
UI and customers using the Customer Portal.

Typically, agents and customers log in using the logins and passwords specied in their Oracle Service Cloud sta
account and contact records. With single sign-on, however, agents and customers are authenticated by a dierent
application, and Oracle Service Cloud accepts authentication and logs them in.

Note:  To enable single sign-on for agents, customers, or both, contact your Oracle account manager.

Oracle Service Cloud supports two types of SSO:

• IdP-initiated SSO

• Service Provider (SP)-initiated SSO (supported only for agents)

IdP-initiated SSO
When agents and customers log in to a external identity provider, the IdP must authenticate their identity. Then they
select a connection to the Service Console (for agents) or your customer portal (for customers).

After verifying the login credentials, the IdP encapsulates the result of the verication in an assertion that is signed
using an X509 certicate and sends the assertion to Oracle Service Cloud. The application veries the signature and
(if successful) accepts the account information for logging in to the Oracle Service Cloud system. The assertion sent
by the identity provider uses SAML 2.0 (Security Assertion Markup Language) architecture. This implementation of
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SAML 2.0 open login lets Oracle Service Cloud accept identity provider assertions. The use of encyrpted SAML tokens
are supported. These are decrypted by Service Cloud using an internal API.

Note:  The identity provider’s login page can be embedded in the Oracle Service Cloud Login window,
providing a seamless method for agents to access the application and any service provider applications
congured in Oracle Service Cloud. See Authentication Using an External Identity Provider on the Oracle
Service Cloud Login Window.

An overview of the IdP-initiated single sign-on process is shown here.

SP-initiated SSO
Oracle Service Cloud also supports SSO initiated from a service provider (SP) instead of an IdP. For example, an agent
may aempt to access Oracle Service Cloud by launching the login window. If SSO is enabled for this specic agent,
Oracle Service Cloud automatically redirects the agent to the appropriate login page the external IdP. The IdP captures
the agent credentials and, if the authentication is successful, redirects the agent back to Oracle Service Cloud with a
SAML assertion.

Note:  Customer login is not supported using SP-initiated SSO.

Agent Login Using an IdP-initiated SSO  
IdP-initiated SSO for agents occurs when single sign-on is enabled for agents who log in to the agent desktop by rst
logging into an external identity provider.
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This ow diagram shows the process ow of an agent accessing the Service Console with an IdP-initiated SSO.

1. An agent enters a user name and password to log in to the organization’s identity provider (such as a
PingFederate Server-based application). When the information is veried, the agent is logged in to the identity
provider.

2. The identity provider displays a list of service providers, including Oracle Service Cloud, that the agent can
connect to.

3. The agent selects Oracle Service Cloud.
4. The identity provider generates a signed SAML 2.0 assertion using the account login, email address, account ID,

or a sta account custom eld as the assertion subject. See How You Identify the SAML Subject for Agent Login.

Note:  The assertion must be signed using  W3C XML signature recommendations . If the certicate
used to sign the assertion is self-signed, it must be uploaded to the Additional Root Certicates
(certs/root) directory in the File Manager. See Certicate Validation Options. The certicate must
also be listed in the SAML_20_SIGN_CERTS conguration seing or it will not be accepted for SAML
signing. See Dene Single Sign-on Conguration Seings. Additionally, the assertion cannot be
encrypted.

5. The identity provider then submits the assertion to the Oracle Service Cloud SSO launch page using HTTP
POST binding (since that is the only binding method supported). The SSO launch page is similar to the
standard launch page except that it automatically starts the ClickOnce URL, which logs the agent in after
validation.

6. Oracle Service Cloud decodes and veries the assertion and validates the account by conrming that the
assertion matches an account in the Oracle database.
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◦ Sta members logging in through an identity provider must have the SSO Login (SAML 2.0) permission
enabled in their prole. See Considerations When Using Single Sign-on.

◦ Because accounts cannot be created through the single sign-on process, only existing accounts can be
logged in. (The public API can be used to create or update accounts if necessary.)

7. Oracle Service Cloud redirects the agent to the ClickOnce URL, which signals the installer to use the SSO login
instead of the standard login, and passes the necessary parameters for automatic login.

8. Oracle Service Cloud veries the account using the parameters of the ClickOnce URL for authentication. If
necessary, the Oracle Service Cloud client is downloaded and installed. The application is then launched, and
the agent is logged in.
See  Server and Client Conguration Issues in ClickOnce Deployments  for information about browser scripting
and compatibility with ClickOnce applications.

Customer Login Using an IdP-initiated SSO  
IdP-initiated SSO for customers occurs when single sign-on is enabled for customers logging in to your customer portal.

This ow diagram shows the process of a customer accessing the customer portal with an IdP-initiated SSO.

1. A customer enters a user name and password to log in to an identity provider. When the identity provider
veries the information, the customer is logged in.
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2. The identity provider displays a list of service providers, including your customer portal, that the customer can
connect to.

3. The customer selects the customer portal.
4. The identity provider generates a signed SAML 2.0 assertion using the customer’s email address, contact

record ID, login name, or a contact custom eld as the assertion subject. See Considerations When Using Single
Sign-on.

Note:  The assertion must be signed using  W3C XML signature recommendations . If the certicate
used to sign the assertion is self-signed, it must be uploaded to the Additional Root Certicates
(certs/root) directory in the File Manager. See Certicate Validation Options. The certicate must
also be listed in the SAML_20_SIGN_CERTS conguration seing or it will not be accepted for SAML
signing. See Dene Single Sign-on Conguration Seings.Additionally, the assertion cannot be
encrypted.

5. The identity provider then submits the assertion, using HTTP POST binding (because that is the only binding
method supported), to the openlogin controller at http://<your_site>.custhelp.com/ci/openlogin/saml. This
controller calls the SSO validation and logs in the customer.

6. Oracle Service Cloud decodes the assertion, validates the customer by conrming that the assertion matches
a contact record in the database, and logs the customer in on your Support Home page. (A redirect parameter
can specify that a dierent page opens instead. See How You Redirect Contacts After Login.)
Contact records cannot be created through the SSO process, so only existing customers can be logged in. (The
public API can be used to create or update contacts if necessary.)

Set Up Single Sign-on (SSO) Using an External Identity Provider  
Complete these steps to congure single sign-on for your site.

1. Contact your Oracle account manager to enable single sign-on for agents, customers, or both.
2. Add the single sign-on permission to the proles that will use it. See Add the SSO Prole Permission.
3. Dene Single Sign-on Conguration Seings.
4. Set up external identity providers (IdPs). See Methods for Seing Up Identity Providers.

a. Identify the SAML subject for agent login. See How You Identify the SAML Subject for Agent Login.
b. Identify the SAML subject for contact login. See How You Identify the SAML Subject for Contact Login.

Add the SSO Prole Permission  
You can add the single sign-on (SSO) permission on the Administration tab of the Proles editor.

For the SSO prole permission to be available, it must be enabled. Contact your Oracle account manager.
1. Click Conguration on the navigation pane.
2. Expand Sta Management, then double-click Proles.

The list of proles displays.
3. Double-click the prole to which you want to assign single sign-on permission.

The Proles editor opens.
4. Click Permissions.

The Permissions page opens with the Administration tab selected.
5. Select SSO Login (SAML 2.0).

A warning message noties you that all sta members having this prole will be prevented from logging in
directly to Oracle Service Cloud and must instead log in through single sign-on with an identity provider. The
warning message also noties you about restrictions for the Customer Portal administration and Public SOAP
API account authentication permissions.

Note:  Single sign-on must be enabled for this check box to display. To enable single sign-on for
agents, customers, or both, contact your Oracle account manager.
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6. Click OK.
7. Click Save.

Related Topics
• Administration Permissions

Considerations When Using Single Sign-on  
When single sign-on (SSO) is enabled for agents on your site, an SSO Login (SAML 2.0) permission check box appears
on the Administration tab of the Proles editor. When you add this permission to a prole, sta members with that
prole can log in only through an identity provider.

Conguration Seings—For security purposes, we recommend that if the SSO Login (SAML 2.0) permission is enabled,
then the SEC_END_USER_HTTPS also be enabled. If both are enabled, then the SAML assertion must be sent to
a secure protocol (https://). To enable SEC_END_USER_HTTPS, contact your Oracle account manager. For an in-
depth discussion about security practices in Oracle Service Cloud, see Overview of Oracle Service Cloud Security and
Compliance.

Restrictions—Several restrictions apply to sta members whose prole includes the SSO Login (SAML 2.0) permission.
Because of the restrictions described here, we recommend creating a prole that does not have the SSO Login (SAML
2.0) permission enabled and assign at least one sta account to that prole. In the event a problem occurs with your
identity provider, that account can log in to Oracle Service Cloud and change other sta member proles (and assign
them passwords, if necessary) so agents can continue to work until the problem is resolved.

• The sta members cannot log in to Oracle Service Cloud using their Oracle Service Cloud credentials, and will
see an access denied message if they try to do so. Possible reasons for the denial are displayed in the message,
including that the account belongs to a prole that allows logins only through single sign-on.

• The prole’s CP Promote, CP Stage, and CP Edit permissions are disabled and cannot be selected when the
SSO Login (SAML 2.0) permission is selected. In addition, sta members using the prole cannot deploy the
customer portal. For more information about Customer Portal permission options, see Assign Permissions for
Customer Portal.

• The sta members cannot edit development pages in WebDAV because WebDAV authentication requires a user
name and password.

• Agents associated with a prole that has the SSO Login (SAML 2.0) permission selected cannot use their
username and password for SOAP API authentication.

• The password options on the Sta Accounts editor are disabled; therefore, passwords cannot be modied for
sta members with proles that have the SSO Login (SAML 2.0) permission enabled. See Add or Edit a Sta
Account.

Related Topics
• Administration Permissions

Dene Single Sign-on Conguration Seings  
The conguration seings described in this procedure support the implementation of SAML 2.0 open login.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Conguration Seings.

The Search window opens.
3. Clear the Select All check box in the Folders menu and then select the Common check box.
4. Click Search.

The Conguration Seings editor opens with the Common folder displayed on the content pane.
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5. Expand the folders in the Common/General/Single Sign-On path to display the SAML_20_SIGN_CERTS and
USE_KNOWN_ROOT_CAS conguration seings on the content pane.

6. Click in the Value column to edit the conguration seing values. See Edit a Conguration Seing.

Conguration Seing Description

SAML_20_SIGN_CERTS Identies the only certicate(s) (a comma-separated list of SHA-1 hex thumbprints) that
are accepted for SAML 2.0 signatures for IdP-initiated SSO. The special value of “ANY-
TRUSTED” may be used to accept any certicate that is trusted by the root CAs for the
site. Default is blank.

Tip:  If the ANY-TRUSTED seing is used, we recommend that the
USE_KNOWN_ROOT_CAS seing be disabled for security reasons.

During IdP-initiated SSO, only certicates listed in the SAML_20_SIGN_CERTS
conguration seing are accepted for SAML 2.0 assertion signing for IdP-initiated SSO.
This means that if no certicates are listed in the seing—which is its default—then no
certicate will be accepted for SAML signing of IdP-initiated single sign-on requests.
Listed certicates must still pass other validation criteria (that is, they must be trusted)
before they can be accepted for SAML 2.0 assertion signing.
 
If the certicate used to sign the assertion is self-signed, it must be uploaded to the

Additional Root Certicates (certs/root) directory in the File Manager. See Certicate

Validation Options.
 

USE_KNOWN_ROOT_CAS Controls whether the known root certicate authorities list that is embedded within the
Oracle server is consulted when verifying X509 certicates, for example, when checking
S/MIME email or SAML 2.0 signatures. Default is enabled (Yes).

7. Click Save.
8. From the search criteria elds on the top of the editor, click the Folders drop-down menu, clear the Common

check box, and then select the RightNow Common check box.
9. Click Search.

The RightNow Common folder displays on the content pane.
10. Expand the folders in the RightNow Common/Single Sign-On/General path to open the SAML_ERROR_URL

conguration seing on the content pane.
You can use this seing to specify the URL where users will be sent if their SAML SSO log-in aempt fails. The
seing supports the %error_code% and %session% placeholder variables, which are replaced with the error code
the user encountered and the session of the user if the user has cookies disabled. The default value for the
seing is blank. These errors can be returned when using the %error_code% variable.

Error name Error ID Description

SAML_TOKEN_REQUIRED 14 No SAMLResponse POST value was sent to the CP controller. A SAML response is
required in order to start the authentication process.

SAML_TOKEN_FORMAT_INVALID 15 The SAML response was found, but it could not be successfully Base 64 decoded.

FEDERATED_LOGIN_FAILED 16 The call to the federated_login API call failed. This usually means that the SAML
assertion succeeded, but the user does not yet exist in the database.
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Error name Error ID Description

SSO_CONTACT_TOKEN_VALIDATE_FAILED 17 The call to the sso_contact_token_validate API failed. This can happen in a number
of ways, but the most common is that the SAML assertion contains something
other than the contact login as the subject. If that login does not exist in the
database, the token validation will fail.

CONTACT_DISABLED_ERROR 6 The SAML assertion/login succeeded, but the contact is disabled in the database.

COOKIES_REQUIRED_ERROR 3 The user does not have cookies enabled. Cookies are required in order to log in to
CP.

11. Click Save.

Methods for Seing Up Identity Providers  
You can congure identity providers using two dierent methods.

• Edit the SAML_20_SIGN_CERTS conguration seing and enter the certicate thumbprint of the IdP that
posts the SAML assertion. This option is generally used with IdP-initiated SSO. See Dene Single Sign-on
Conguration Seings for a description of the conguration seing.

• Congure the IdP using the Single Sign-On Congurations editor. Identity providers congured using this
method are used only for SP-initiated SSO. They are ignored when validating SAML assertions for IdP-initiated
SSO. See Authentication Using an External Identity Provider on the Oracle Service Cloud Login Window.

For Oracle Service Cloud to accept SAML 2.0 open login assertions from external identity providers, each identity
provider must be congured to send the assertion URL to the Oracle Service Cloud application, either to the SSO launch
page for agent login or to the openlogin controller for customer login (or to both):

• Identify the SAML subject used in the assertion for agent login.

• Identify the SAML subject used in the assertion for customer login.

Oracle Service Cloud can accept authentications from multiple identity providers. Conguration details vary from
provider to provider, so each one must be congured separately to make the application available through the identity
provider. Because the procedures vary, we cannot provide specic details. However, this list includes some requirements
and constraints you must consider as you congure an identity provider:

• Oracle Service Cloud supports only the HTTP POST binding type, so the identity provider should be congured
to send SAML responses and assertions using that method.

• The certicate used to sign the assertion must be included as part of the assertion in the XML signature.

• The identity provider server is expected to be time-synchronized with the Oracle server, so a validity range of
plus or minus ve minutes of the SAML assertion should be adequate.

Note:  If Windows ADFS (Active Directory Federation Services) is used as the identity provider, the
xed validity ranges (ve minutes for Subject.SubjectConrmationData.NotOnOrAfter and one hour for
Subject.Conditions.NotOnOrAfter) can cause validation errors if the application’s clock is behind the time of
the identity provider, even if that dierence is as small as one second. To mitigate the potential problem, a
NotBeforeSkew parameter can be issued in these PowerShell prompts.

PS C:/Users/Administrator> add-pssnapin microsoft.adfs.powershell
PS C:/Users/Administrator> set-adfsrelyingpartytrust -targetname "<relying party name>" -
NotBeforeSkew 2

In this example, 2 means two minutes; however, you can change the value as needed.
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How You Identify the SAML Subject for Agent Login  
The parameter used to identify the SAML subject contents must be passed to the SSO launch page as a GET parameter.

The subject value must be unique for the single sign-on to be successful. For example, if multiple sta members can
have the same value for an account custom eld, then do not use that custom eld as the subject.

The value denes how the SAML subject is mapped to an existing sta account in the Oracle database. Only one eld
can be passed in the assertion subject, whose parameter name is p_subject.

Acceptable values for p_subject depend on whether the ow is IdP-initiated SSO or SP-initiated SSO. If SSO is initiated
by Oracle Service Cloud (in other words, SP-initiated SSO), the only allowed value for p_subject is Account.Login. If
SSO is initiated by an external provider (in other words, IdP-initiated SSO), the p_subject value can be any one of the
following:

• Account.Login—The assertion subject is the account login, which is the preferred mapping since it requires no
additional lookup from the database. That is, the value can be passed to the sso_account_login() API. This is the
default mapping value if p_subject is not set. The Account.Login value is case sensitive.

Note:  This is the only value permied for p_subject when the SSO is initiated by Oracle Service Cloud
in an SP-initiated process.

• Account.Emails.Address—The assertion subject is the account email address. The Account.Emails.Address
value is case insensitive.

• Account.ID—The assertion subject is the account ID in the Oracle database.

• Account.CustomFields.[customeld-name]—The customeld-name variable is the actual name of the custom
eld in the database (and the name of the database column), and the assertion subject is the account custom
eld value. The custom eld name is the last name in the dot-separated value. It is automatically dened with
lowercase notation and the c$ prex.

The custom eld value is case insensitive. These sta account custom eld data types are not supported for use in an
assertion:

• Menu

• Yes/No

• Date/Time

• Date Field

This is an example of an assertion URL that passes the value of a custom eld called accounts.c$external_id eld for
the sta account being veried.

https://my_site/cgi-bin/my_interface.cfg/php/admin/sso_launch.php?
p_subject=Account.CustomFields.ExternalPhone

Note:  The latest version of the single sign-on URL for agents no longer accepts custom elds. Previously,
custom elds in the query helped identify the SAML subject type. However, the SAML subject type passed by
the external entity provider is now specied in the single sign-on conguration. An example of a URL using
the new conguration follows.

https://my_site/cgi-bin/my_interface.cfg/php/sso/sam12/sp/post/acs.php 
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How You Identify the SAML Subject for Contact Login  
For contacts, only IdP-initiated SSO is supported. The parameter used to identify the SAML subject contents must be
passed to the openlogin controller as a GET parameter.

The format of the URL is:

 your_site/ci/openlogin/saml/subject/SAML_subject
 

For example:

mysite.example.com/ci/openlogin/saml/subject/contact.emails.address

The subject value must be unique in order for the single sign-on to be successful. For example, if email address sharing
is enabled, the potential for more than one contact having the same email address exists (even if the primary email
address for one is the alternate email address of another), so you should not use the email address as the subject. A
similar situation might occur with custom elds if multiple customers can have the same value for a contact custom
eld.

The parameter, named subject, is optional and defaults to contact.login. Its values include the following:

• contact.emails.address—The assertion subject is the contact email address, and the value can be the contact’s
primary email address or one of the alternate email addresses. The contact.emails.address value is case
insensitive.

• contact.id—The assertion subject is the contact ID in the Oracle database.

• contact.login—The assertion subject is the contact login, which is the preferred mapping since it requires no
lookup from the database. This is the default mapping value if subject is not set. The contact.login value is case
sensitive.

• contact.customelds.[customeld-name]—The customeld-name variable is the actual name of the custom
eld in the database (as well as the name of the database column), and the assertion subject is the contact
custom eld value. The assertion subject is then passed to the API as CustomField and the name in the subject
GET parameter is sent to the API as the CustomFieldName value. The c$ prex is added if necessary.

Note:  The custom eld value is case insensitive. These contact custom eld data types are not supported for
use in an assertion:

• Menu

• Yes/No

• Date/Time

• Date Field

• Opt-in

How You Redirect Contacts After Login  
After the assertion has been veried and contacts are identied and logged in, they will be directed to your Support
Home page by default.

If you prefer to direct contacts to another page, you can add a redirect parameter to the URL that passes the subject
parameter. The redirect parameter can point to any page (/app/*) or controller endpoint (/ci/* or /cc/*). It must follow
the subject parameter, as shown in this example URL:
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https://your_site/ci/openlogin/saml/subject/contact.id/redirect/app/ask

Authentication Using an External Identity Provider on the Oracle
Service Cloud Login Window  
Your sta members can log in on the Oracle Service Cloud Login window using authentication from external IdPs. This
lets agents log in once to be authenticated across several service-provider (SP) applications.

Single logout is also supported, so that when agents log out of any SP application, they are also automatically logged
out of the IdP and any other SPs where they were logged in.

See Dene an External IdP for Agent Authentication on the Login Window for information about conguring external
IdPs.

Note:  Deployments involving Oracle Service Cloud and Oracle Sales Cloud use Oracle Identity Management
because Oracle Identity Management is bundled with Oracle Sales Cloud.

When the sta member logs in to the IdP, an encrypted SAML token is generated and passed to Oracle Service Cloud.
This method increases security because user IDs and passwords are not sent between the applications.

After being authenticated, Oracle Service Cloud provides authentication services to other SPs, alleviating the need to
integrate them and the external IdP.

Dene an External IdP for Agent Authentication on the Login Window  
Follow this procedure to congure an external identity provider for agent authentication on the Login window.

This procedure assumes that:

• You have added the Single Sign-On Congurations component to the conguration list for the Conguration
buon. See Create a Navigation Set for the Administrator.

• You have access to the Identity Provider editor dened by the hidden conguration seing
SSO_ENABLE_EXTERNAL_IDP. This seing is not enabled by default. To enable this hidden seing, contact
your Oracle account manager or submit a service request on our  support site.

1. Click Conguration on the navigation pane.
2. Double-click Single Sign-On Congurations in your navigation list. The Single Sign-On Congurations editor

opens with the SAML tab active.
a. Click New on the ribbon and select SSO Identity Provider.

The Identity Provider editor opens on the content pane.
b. Enter eld information.

Field Description

Provider Entity ID* Enter a unique name for the IdP in this eld.

Active Select this check box to enable the IdP. You can congure multiple IdPs in
Oracle Service Cloud.
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Field Description

Web SSO Select this check box to redirect agents to the IdP when they log in on the
Oracle Service Cloud Login window. See Log in with an External Identity
Provider on the Service Cloud Login Window. Only one active IdP can be
enabled for Web SSO.

Enforce Audience Restriction Select this check box to force the aud aribute (audience) of the SAML
token to include the custom audience URL. Enforcing an audience restriction
ensures that only tokens meant for the specic site are consumed.

Custom Audience URL Enter the custom audience URL that the SAML token must match, for
example:

https://customaudience.com/services/saml

If the Enforce Audience Restriction check box is selected, and the custom
audience URL is not specied, then the token must include the interface URL
in its audience list. Entries in this eld are ignored when Enforce Audience
Restriction is not selected.

NameID Format Select either Unspecied or Email Address from the drop-down menu. The
NameID aribute is used in two places for enhanced validation:

- Incoming SAML assertion from the IdP

- Outgoing logout request to the IdP

Subject Type Click the drop-down menu and select the subject type used in the SAML
token. The options are Email, Login Name, and Account ID. The default value
is Login Name.

Label* Click the arrow next to Labels to expand this section. Enter the name as you
want it to display for the IdP in the Label column. You can specify dierent
names to use for dierent interfaces and languages.

SAML Token Parameters Click the arrow next to SAML Token parameters to expand this section and
congure the SAML token parameters.

Token Validity Oset Enter the number of seconds that the timestamp on SAML tokens is adjusted
by to account for discrepancies between the Oracle Service Cloud and
external IdP clocks.

Token Validity Enter the number of seconds that the timestamp on SAML tokens will be
accepted.

Certicates Click the arrow next to Certicates to expand this section. Click the folder
next to the Import Certicate eld to select the location of the certicate you
want to use to validate requests and SAML tokens received from the IdP. The
certicate populates in the Certicate eld. You can also specify an alternate
certicate to use when validation fails using the primary certicate.
 
You can click the X icon to delete the certicate. Certicates can be deleted
if there is more than one certicate congured for the IdP or if the IdP is
inactive.
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Field Description

Signing Parameters Click the arrow next to Signing Parameters to expand this section where you
can enter information to congure the signing method.

Add Certicate to Signature Clear this check box to prevent the signing certicate from being added to
the SAML response/assertion signature.

Sign Response Clear this check box to prevent the response part of the SAML token from
being signed.

Sign Assertion Clear this check box to prevent the assertion part of the SAML token from
being signed.

Sign Method Click this drop-down menu to select the XML signature method used to sign
the SAML token. You can select:

- RSA + SHA-1

- RSA + SHA-256

- RSA + SHA-512

Sign Digest Method Click this drop-down menu to select the digest method used to sign the
SAML token signature. You can select:

- SHA-1

- SHA-256

- SHA-512

Auto Provisioning Click the arrow next to Auto Provisioning to expand this section where you
can enable and congure the ability to automatically create sta accounts
and enable or disable auto-provisioning for each IdP.

Enable Auto-Provisioning Select this check box to enable this IdP for auto-provisioning of sta
accounts.

Default Prole Click the Search icon to select the prole you want to associate to this IdP.

Default Group Click the Search icon to select the group you want to associate to this IdP.

First Name Enter the value for the sta member as it corresponds to the FName aribute
mapping.

Last Name Enter the value for the sta member as it corresponds to the LName aribute
mapping.

Title Enter the value for the sta member as it corresponds to the JobTitle
aribute mapping.

Phone Enter the value for the sta member as it corresponds to the Phone aribute
mapping.

Email Address Enter the value for the sta member as it corresponds to the EMail aribute
mapping.
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Field Description

User Name Enter the value for the sta member as it corresponds to the Login aribute
mapping.

c. Click Save.
d. To export the Oracle Service Cloud metadata to an XML le, click Export SP Metadata on the ribbon

and then browse to the XML le that is created into the external IdP’s web server. This establishes a trust
relationship between the IdP and Oracle Service Cloud. If the external IdP encounters a problem with the
entity ID in the exported metadata, the entity ID can be changed. Contact your Oracle account manager.

e. To import the metadata from the external IdP into Oracle Service Cloud, click Import IdP Metadata on
the ribbon and browse to the le you want to import.

f. Click Save and Close to save your changes and close the editor.
3. To create or edit a prole, click Permissions on the ribbon, and select the SSO Login (SAML 2.0) check box in

the Administration section.
For more information on prole permissions, see Proles.

4. To create or edit a sta account in Oracle Service Cloud and associate the prole with it. See Add or Edit a Sta
Account.

Note:  The sta account must also be a registered user in the external IdP and the user ID must match
the Oracle Service Cloud user name.

Log in with an External Identity Provider on the Service Cloud Login Window  
After the external IdP is congured, sta members open the Oracle Service Cloud Login window as they normally would.
However, the IdP’s login page is now embedded in the window.

You must have the SSO Login (SAML 2.0) prole permission selected in your prole.
1. Launch Oracle Service Cloud.

The external IdP’s login page is embedded in the Login window.
2. Enter your login information.

The IdP veries your credentials, generates a SAML token, and sends it to Oracle Service Cloud. The SAML
token is authenticated with the certicate used to sign the token.
You are then logged in to Oracle Service Cloud.

Bypass the External Identity Provider  
If sta members do not have the SSO Login (SAML 2.0) prole permission, the IdP can be bypassed, leing them log in
using their Oracle Cloud Service credentials.

After conguring and enabling an IdP in Oracle Service Cloud, your site’s launch page includes an option for Install
Oracle Service Cloud—Internal Login.

Note:  This option is intended for troubleshooting single sign-on issues, and is not meant to be used as a
conventional sign-on process.

1. Launch Oracle Service Cloud.
2. Select Install Oracle Service Cloud—Internal Login.
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The login window without the embedded IdP page is loaded. This is an example of a URL for a launch page:
https://your_site/cgi-bin/interface_name.cfg/php/admin/launch.php

Use OpenID-based External Identity Providers  
Oracle Service Cloud supports the use of OpenID Connect (OIDC) external identity providers for single sign-on
authorization.

OpenID Connect (OIDC) is a widely used authorization protocol based on REST, JSON, and OAUTH 2.0 standards. OIDC
support allows administrators to dene and manage OIDC providers on the Agent Browser UI.

Using OIDC has these benets:

• Agents have seamless access to Oracle Service Cloud.

• OIDC eliminates the need for multiple credentials. Agents can log into Oracle Service Cloud using their
credentials with popular OIDC providers.

• OIDC can be used for both web single-sign on and APIs.

• A single logout terminates the session, regardless of where the logout originates.

• Unlike SAML, OIDC can be used on mobile platforms.

You perform these tasks to set up OIDC:

1. Register Oracle Service Cloud as a client with the OIDC provider.
2. Dene the OIDC provider in Oracle Service Cloud.

OIDC authorization uses this process:

1. An agent tries to log in to Oracle Service Cloud.
2. Oracle Service Cloud sends an authorization request to the OIDC provider.
3. If the agent is authorized, then the OIDC provider returns an authorization code.
4. Oracle Service Cloud sends an access token request to the OIDC provider using the authorization code.
5. The OIDC provider issues the access token.
6. Oracle Service Cloud creates a session using the access token.

Register Oracle Service Cloud with the OpenID Connect Provider  
You register Oracle Service Cloud as a client with the OpenID Connect (OIDC) provider.

1. Enter information about Oracle Service Cloud in the OIDC provider:

Parameter Value

Allowed Grant Types Authorization Code

Client Type Condential

Redirect URL Oracle Service Cloud URL where to redirect after the authorization code is generated:

http://your_site/cgi-bin/your_interface.cfg/php/sso/oidc/idp/
oidcs.php

Logout URL Oracle Service Cloud URL where to post the logout request:
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Parameter Value

http://your_site/cgi-bin/your_interface.cfg/php/sso/saml2/idp/post/
logout.php

Post Logout Redirect URL Same as the redirect URL:

http://your_site/cgi-bin/your_interface.cfg/php/sso/oidc/idp/
oidcs.php

Dene the OpenID Connect Provider in Oracle Service Cloud  
You use the OIDC Providers editor in Oracle Service Cloud to enter information about OpenID Connect external identity
providers.

This procedure assumes that:

• You have added the Single Sign-On Congurations component to the conguration list for the Conguration
buon. See Create a Navigation Set for the Administrator.

• You have enabled the hidden conguration seing SSO_ENABLE_EXTERNAL_IDP. This seing is not enabled by
default. To enable this hidden seing, contact your Oracle account manager or submit a service request on our 
support site.

1. In the Agent Browser UI, click the Navigation Menu icon, then select OIDC Providers.
2. Click New on the toolbar.

The New OpenID Connect Provider editor displays.
3. Enter eld information. All elds are required except Active.

Field Description

Provider Entity ID Enter a unique name for the OpenID Connect (OIDC) provider in this eld.

Active Select this check box to enable the OIDC provider.

Authorization Endpoint URL on OIDC provider for authorization token

Token Endpoint URL on OIDC provider for access token

Client ID Unique ID assigned to Oracle Service Cloud by the OIDC provider

Client Secret Condential key assigned to Oracle Service Cloud by the OIDC provider

Scope openid

ID Token Provider Select the link to navigate to the page where you congure the ID token provider.

Web SSO Select this check box to make the OIDC provider the default external identity provider.

Note:  Only one active identity provider can be enabled for Web SSO (across
both the SAML and OIDC protocols).
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Log in to External Applications Using Oracle Service Cloud as the
Identity Provider  
You can congure Oracle Service Cloud to act as an identity provider to store and authenticate credentials for other
applications. This allows your agents to seamlessly access applications that reside outside the Oracle cloud from the
Service Console or Agent Browser UI.

To enable the option to use Oracle Service Cloud as an identity provider, you must:

• Enable the SSO_IDP_ENABLE_EXT_APPS conguration seing.

• Add the Single Sign-On Congurations component to your navigation set.

Using the Single Sign-On Congurations editor, you can create and administer SSO service providers and SSO service
applications. Service providers are containers where you group multiple service applications. Each service application in
a service provider will have the same SAML response and assertion methods.

Note:  Service providers and applications hosted by Oracle display on the Single Sign-On Congurations
editor, though you cannot modify most of their properties. You can, however, edit their labels and enable
and disable them on your site. For information about hosted SSO integrations, contact your Oracle account
manager.

1. Navigate to Single Sign-On Congurations.
2. In the Single Sign-On Congurations editor, create a service provider.
3. Create a service application.
4. Add the service application to a workspace where agents can then access the external application without being

asked for sign-in credentials.
See Add Applications to the Service Console or Agent Browser UI.

When an external application is congured to use Oracle Service Cloud as the identity provider, agents will be redirected
to a PHP login page if they aempt to access the external application’s login page directly from a URL.

These procedures describe how to create an SSO service provider and an SSO service application, and how to view the
audit log to see all related activity.

Related Topics
• Redirection to the Oracle Service Cloud Login Page

• Search for a Conguration Seing

• Edit a Conguration Seing

• Create an SSO Service Provider

• Create a Service Application

• View the Single Sign-On Congurations Audit Log

Create an SSO Service Provider  
Follow the steps outlined in this procedure used to create an SSO provider.
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Before you can create an SSO service provider, you must add the Single Sign-On Congurations component to the
conguration list for the Conguration buon. See Create a Navigation Set for the Administrator.

1. Click Conguration on the navigation pane.
2. Double-click Single Sign-On Congurations in your navigation list.

The Single Sign-On Congurations tree opens with the SAML tab active.
3. Click New on the ribbon, then select SSO Service Provider.

The Service Provider editor opens.
4. Enter eld information.

Field Description

Provider Entity ID* Enter a unique name for the service provider in this eld.

Enabled Clear this check box to prevent the service provider from being enabled for single
sign-on integrations. After you are ready to use the service provider and its associated
service applications, select the check box to enable it.

Use as Template Select this check box to use the values for this service provider as your template values.
If designated as the template, this service provider values are used for generating the
SAML token when an Add-In requests a SAML token without specifying a specic
service provider ID.
Only one service provider can be designated as the template.
 

Audience Type Click the drop-down menu to select the type of audience for the service provider.
Options include:

◦ None—Generated SAML token is valid for all domains and URLs.

◦ Restricted—Generated SAML token is valid only for the specic domains and URLs
dened by the token.

◦ Custom—Generated SAML token is valid for the domains and URLs dened in the
Custom Audience URL eld.

The default value is Restricted.
 

Custom Audience URL Enter the domains and URLs you want to specify as valid in this eld.
This eld displays only when the Audience Type is set to Custom.
 

Labels* Click the arrow next to Labels to expand this section. Enter the name as you want it to
display for the service provider in the Label column. You can specify dierent names to
use for dierent interfaces and languages.

SAML Token Parameters Click the arrow next to SAML Token Parameters to expand this section and enter
information to congure the SAML assertion.

Assertion Consumer Service URL* Enter the URL where the SAML token will be posted. SAML responses and assertions
will be sent to this location using HTTP POST binding.

Assertion Audience Restriction Enter the domain for which the SAML assertion is intended or for which it is valid.

Assertion Validity Duration Enter the time, in seconds, for which the SAML assertion is valid. Values can be from 0
to 86,400 (24 hours).
The default value is 300 (5 minutes).
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Assertion Validity Start Enter the relative oset, in seconds, to the current time when a generated SAML
assertion’s validity should start. Values can be from -1800 to +1800.
The default value is 0.
 

Include InResponseTo element in
Assertion

Select this check box to include the InResponseTo element in the SAML assertion.
The default value is No (unchecked).
 

Logout Parameters/Certicates Click the arrow next to Logout Parameters to expand this section.
The elds in this section are used to congure single logout for external service
applications when using Oracle Service Cloud as the identity provider. See Single Logout
for SSO Applications.
 

Logout URL Enter the URL where the identity provider sends the logout request to the service
provider.

Logout Validity Duration (in
seconds)

Enter the number of seconds the identity provider’s logout request will be valid.

Certicates Click the arrow next to Certicates to expand this section.
The elds in this section are used to congure certicates for single logout for external
service applications when using Oracle Service Cloud as the identity provider.
 
Click the folder next to the Import Certicate eld to select the location of the certicate
you want to use. The certicate populates in the Certicate eld. You can also specify an
alternate certicate to use when validation fails using the primary certicate.
 

Signing Parameters Enter information to congure the signing method in this section.

Add Certicate to Signature Clear this check box to prevent the signing certicate from being added to the SAML
response/assertion signature.

Sign Response Clear this check box to prevent the response part of the SAML token from being signed.

Sign Assertion Clear this check box to prevent the assertion part of the SAML token from being signed.

Sign Method Click this drop-down menu to select the XML signature method used to sign the SAML
token. You can select:

◦ RSA + SHA-1

◦ RSA + SHA-256

◦ RSA + SHA-512

Sign Digest Method Click this drop-down menu to select the digest method used to sign the SAML token
signature. You can select:

◦ SHA-1
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◦ SHA-256

◦ SHA-512

5. Click Save.

Create a Service Application  
Use the following procedure to create a service application.

Before you can create a service application, you must add the Single Sign-On Congurations component to the
conguration list for the Conguration buon. See Create a navigation set for the administrator.

1. Click Conguration on the navigation pane.
2. Double-click Single Sign-On Congurations in your navigation list.

The Single Sign-On Congurations tree opens with the SAML tab active.
3. Select the SSO service provider you want the service application associated with.

The Service Provider editor opens.
4. Click New on the ribbon and select SSO Service Application.
5. Enter the URL that a browser using the application should navigate to in the Base URL eld.
6. Click the Type drop-down menu and select the type of application.

Options include the following:

◦ Oracle ATG Web Commerce Service Center

◦ Oracle ATG Engagement Engine

◦ Oracle InQuira Knowledge

◦ Unspecied

7. To prevent the service application from being available on the Service Console or Agent Browser UI, clear the
Enabled in Console check box.

8. To prevent the service application from being available in a browser control, clear the Available in Browser
Control check box.

9. To dene how you want the service provider to display on the Service Console or Agent Browser UI, click the
arrow next to Labels and enter the name you want to use for the service provider in the Label column.
You can specify dierent names to use for dierent interfaces and languages.

10. Click Save.

View the Single Sign-On Congurations Audit Log  
Use the following procedure to view the Single Sign-On Congurations editor audit log.

1. Click Conguration on the navigation pane.
2. Double-click Single Sign-On Congurations in your conguration list.

The Single Sign-On Congurations editor opens.
3. Click the name of the service provider, service application, or identity provider you want to examine.
4. Click Audit Log.

The Audit Log window opens displaying the time the action occurred, the sta member who made the change,
the type of action, and where on the administration interface the action was performed.
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Add Applications to the Service Console or Agent Browser UI  
After you congure SSO service providers and service applications, you must add the service applications you want
your agents to access to the Service Console or Agent Browser UI.

1. Create or edit the workspace your sta members will use to access the external applications.
2. Add a browser control to the workspace.

SSO service applications you have created are available as options in workspace browser controls.
3. Select the service application from the Application drop-down menu on the ribbon’s Design tab, and drag it to

the workspace.

When your sta members use the workspace, they will be able to access the application and will not be asked for
credentials.

Redirection to the Oracle Service Cloud Login Page  
After conguring external applications to use Oracle Service Cloud as the identity provider, agents who aempt to
directly access the external application’s login page will be redirected to a PHP login page where they can enter their
Oracle Service Cloud credentials.

If agents forget their login information, they can click Login Help on the page to recover their information. Using the
ACCT_RECOVER_STATUS and ACCT_RECOVER_ALT conguration seings (RightNow User Interface/Tool Bar/
General), you can choose what action is taken when sta members forget their user name or password. See Login Help
Options.

Note:  Seing ACCT_RECOVER_STATUS to 0 disables login help functionality on the PHP login page, because
this value opens the login help procedure in the Oracle Service Cloud online documentation.

Related Topics
• Search for a Conguration Seing

• Edit a Conguration Seing

Single Logout for SSO Applications  
Single logout for internal service providers is enabled automatically. Logout for external service providers requires
editing the service provider conguration.

If your agents use single sign-on (SSO) to log in to other applications using Oracle Service Cloud as the identity provider,
they can be automatically logged out of all the service providers they are logged into when they log out of any one
of them. The applications can be external or internal to the Oracle cloud (such as  Oracle Policy Automation ). This
enhances the security for all the applications, because users would be forced to reenter their credentials after they log
out of any one of them.

• Internal service providers—Single logout for internal service providers is enabled automatically and requires no
conguration other than that described in Create an SSO Service Provider. Logout requests by service providers
internal to the Oracle cloud do not require certicates because they are assumed to be secure.

• External service providers—Conguring single logout for an external service provider requires editing the
service provider conguration in the Single Sign-On Congurations editor to add logout parameters and
certicates.
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CAUTION:  You must also congure the NameID Format parameter. If the NameID Format parameter
for Oracle Service Cloud and the external IdP do not match, then your agents might not be logged out
automatically from other service providers. See Dene an External IdP for Agent Authentication on the
Login Window.

Logout requests by external service providers must be signed using valid certicates to ensure that the logout
request can be trusted. External service providers can also use alternate certicates to help transition from
expiring certicates.

Related Topics
• Create an SSO Service Provider

• Enable Single Logout for an External Service Provider

Enable Single Logout for an External Service Provider  
If your agents use single sign-on (SSO) to log in to other applications using Oracle Service Cloud as the identity provider,
they can be automatically logged out of all the service providers they are logged into when they log out of any one of
them.

This procedure assumes that:

• Single sign-on is enabled on your site and that you have already added the external service provider to Oracle
Service Cloud.

• You have added the Single Sign-On Congurations component to the conguration list for the Conguration
buon. See Create a Navigation Set for the Administrator.

1. Click Conguration on the navigation pane.
2. Double-click Single Sign-on Congurations in your navigation list.

The Single Sign-On Congurations tree opens.
3. Select the service provider for which you want to enable single logout in the tree.

The Service Provider editor opens.
4. Click the arrow next to SAML Token Parameters.
5. Click the arrow next to Logout Parameters and enter the URL where the identity provider sends the logout

request to the service provider in the Logout URL eld.
6. Enter the number of seconds the identity provider’s logout request will be valid in the Logout Validity Duration

eld.
The default value is 600 seconds.

7. Click the arrow next to Certicates to expand the section.
8. Click the folder next to the Import Certicate eld to select the location of the certicate you want to use to

validate logout requests.
After you select the certicate le, it populates the Certicate eld.

9. To use a second certicate to validate logout requests, click the folder next to the Import Alternate Certicate
eld and select the certicate you want to use.
Using an alternate certicate is useful if you are transitioning from an expiring certicate.

10. Click Save.
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Use OAuth Authorization to Access the Connect REST API  
You can use an external identity provider (IdP) to store your credentials, and use these credentials for making requests
to the Connect REST API. You can also use these credentials to make requests to the Knowledge Advanced REST API.

You must perform these tasks to use an external IdP for making REST API requests.
1. Congure the External Identity Provider.
2. Download a security certicate from the external IdP to your local computer.
3. Congure Oracle Service Cloud for OAuth Authorization.

Congure the External Identity Provider  
This is a general procedure. The exact steps depend on the particular identity provider (IdP) used.

1. Congure Oracle Service Cloud as a trusted client.
2. Specify the primary audience to be the Connect REST API endpoint, for example:

https://mysite.example.com/services/rest/

3. Specify the secondary audience, if needed, to be the Knowledge Advanced REST API endpoint, for example:
https://mysite.example.com/services/km/api/latest/

4. Set the scope to /all, so that when an OAuth access token is requested from the IdP, the primary and
secondary audiences are set in the token.

Download a security certicate from the external IdP to your local computer. Then Congure Oracle Service Cloud for
OAuth Authorization.

Congure Oracle Service Cloud for OAuth Authorization  
You must perform these tasks to use OAuth authorization with the Connect REST API. These tasks are not required if
you plan to use OAuth authorization only with the Knowledge Advanced REST API.

This procedure assumes that you have access to the Identity Provider editor dened by the hidden conguration seing
SSO_ENABLE_EXTERNAL_IDP. This seing is not enabled by default. To enable this hidden seing, contact your Oracle
account manager or submit a service request on our  support site.

1. Create a prole for the OAuth user that has the SSO Login (SAML 2.0) permission enabled under Administration
permissions.
See Add or Edit a Prole for more information.

2. Create a sta account for the OAuth user and assign the OAuth user prole to it.
See Add or Edit a Sta Account for more information.

Note:  The OAuth user sta account must not be disabled or locked.

3. Dene the external IdP in Oracle Service Cloud.
See Dene the External Identity Provider for OAuth Authorization.

4. Retrieve a token from the external IdP.

Note:  The OAuth user must be dened in the external IdP.

You can now use the token in Connect REST API and Knowledge Advanced REST API calls. To Revoke OAuth Access
Tokens, use the Manage Access Tokens editor.
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Dene the External Identity Provider for OAuth Authorization  
You dene the external identity provider (IdP) on the OAUTH tab of the Single Sign-On Congurations editor.

You must perform these tasks before dening the external IdP:

• Congure the external IdP.

• Download the security certicate from the external IdP to your computer.

• Add the Single Sign-On Congurations component to the conguration list for the Conguration buon, for
example to the Site Conguration tree. See Create a Navigation Set for the Administrator.

1. Click Conguration on the navigation pane.
2. Double-click Single Sign-On Congurations in your navigation list.

The Single Sign-On Congurations editor opens with the SAML tab active.
3. Click the OAUTH tab.
4. Click New on the ribbon and select SSO Identity Provider.

The Identity Provider editor opens on the content pane.
5. Enter this information:

Field Description

Provider Entity ID Required. Enter a unique entity ID for the external IdP.

Active Select this check box to make the external IdP active.

Enforce Audience Restriction Select this check box to force the aud aribute (audience) of the OAuth token to include
the custom audience URL.
Enforcing an audience restriction ensures that only tokens meant for the specic site are
consumed.
 

Custom Audience URL Enter the custom audience URL that the OAuth token must match, for example:

https://customaudience.com/services/rest

Note:  If the Enforce Audience Restriction check box is selected, and the
custom audience URL is not specied, then the token must include the
interface URL in its audience list.

Token Validity Enter the length of time in seconds from 1 to 86400 (1 day) for the OAuth token to

remain valid from the time issued. If no expiration time is set by the external IdP, the

default validity is 120 seconds.

The length of time that the token is valid is the lesser of the following:

◦ Time issued plus token validity

◦ Expiration time set by the issuing IdP

 

Label Required. To change the display name of the external IdP, click the arrow next to Labels
and enter a label as you want it to display.
The default is New IDP Provider.
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Field Description

 

6. Click the arrow next to Certicates drop-down arrow, then click the folder next to the Import Certicate eld.
7. Browse for the security certicate you downloaded from the external IdP, then click Open.

The certicate is imported.
8. Click Save.

The external IdP denition is shown in the Identity Providers list.

Use the Manage Access Tokens editor to Revoke OAuth Access Tokens as needed.

Revoke OAuth Access Tokens  
You use the Manage Access Tokens editor to revoke OAuth access tokens.

You must add the Manage Access Tokens component to the conguration list for the Conguration buon, for example
to the Common tree. See Create a Navigation Set for the Administrator.

1. Click Conguration on the navigation pane.
2. Expand Common, then double-click Manage Access Tokens.

The Search window opens.
3. Enter or choose search terms, then click Search.

Access tokens are displayed in the list.
4. Click the Revoke link in the Action column to revoke a token.

That token can no longer be used to makes REST API calls.
5. Click the Unrevoke link to make the token valid again.

You can unrevoke tokens as long as they have not expired.

Add-Ins  

Overview of Add-Ins  
The desktop add-in framework lets application developers add custom components, or add-ins, to Oracle Service Cloud
to integrate with other applications on sta members’ workstations.

Add-ins are uploaded using the Add-In Manager. From the manager, you can provide or deny access to individual add-
ins for each prole and interface. Sta members who are granted access to use add-ins will have the necessary add-
in les downloaded to their workstations. For information about managing add-in permissions through proles, see
Proles. For information about creating add-in les, see Desktop Add-Ins (.NET API) Developer Guide.

Note:  In severe cases, a malfunctioning add-in can prevent the Service Console from functioning properly
and can even prevent administrators from logging in to remove the malfunctioning add-in. If this occurs and
you are required to exit the administration interface without completing the normal logout process, the system
noties you the next time you log in that Oracle Service Cloud did not exit properly the last time, and asks if
you want to log in using safe mode. Safe mode temporarily disables your add-ins, allowing you to log in and
remove the malfunctioning add-in.
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Add-In File Conventions  
The add-in les you upload must conform to certain conventions to be recognized by the Add-In Manager.

• The les must be either direct linked library (DLL) les that reference the add-in views or zipped (.zip) archives.

• Zip les can contain any number of les but must not contain subdirectories. If subdirectories are included in
the zipped archive, the subdirectories will be removed.

• Zip les must contain only one .dll le that references the add-in views. If more than one add-in is included in
the zipped archive, the add-ins will not be properly activated. The .dll le in the zipped archive that contains the
reference to the add-in views must have the same name as the zipped archive.

• The names of .dll les you upload must be unique and the names of the assemblies they contain must match
the .dll le names. If the name of the assembly does not match the name of the .dll le you upload, the
assembly will not link correctly with the proles that should have permission to use it.

Install a New Add-In  
Using the Add-In Manager, you can quickly upload les and assign prole permissions to use the add-ins.

You can also specify custom values for .NET aributes from the Add-In Manager. Additionally, you can specify dierent
values for each prole and interface and the specied values are stored in the Oracle database. This eliminates the need
to store custom values for aributes in client-side XML conguration les.

The Add-In Manager is available to only those sta members with the Conguration permission selected on their
prole’s Administration tab.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Add-In Manager.

The Add-In Manager opens on the content pane.
3. To open an existing add-in for editing, click the add-in name. If the add-in’s .dll or .zip le has been modied or

replaced by a dierent le, you can update the add-in to reect the changes.
4. To install a new add-in, click New, then select Agent Desktop Add-In.

Note:  When the Open window initially displays, only .dll les appear. To view .zip les, click the Files
of Type drop down menu and select Compressed Add-In Files.

a. Select the add-in’s le and click Open.
The Add-In Details editor displays. The Name and API DLL Version elds are populated.

Field Description

Name The name of the .dll or .zip le you uploaded.

API DLL Version The version of the add-in API that the le was built against.

Created The date and time the add-in was initially uploaded.

Created By The sta member who uploaded the add-in.
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Field Description

Updated The date and time the add-in was most recently updated.

Updated By The sta member who most recently updated the add-in.

5. To select a dierent le for the add-in, click Folder in the Name eld, select the le, and then click Open.
6. To add a note to the add-in, enter it in the Notes eld.
7. To specify the proles that can access the add-in, click Prole Access.

a. Select the prole in the Proles Allowed to Access section.
b. Select the appropriate interface check boxes in this section. Only interfaces that the prole has

permission to access are displayed in the Interfaces section.
c. To give the selected prole access to the add-in on all interfaces, select the Select All check box.
d. To grant add-in access to all proles on all interfaces, click Apply All.
e. To remove add-in access from all proles and interfaces, click Clear.

When you enable the add-in for a prole and interface, the class names, property names, and default values for
the add-in’s congurable properties display.

8. Select the property you want in the Server Conguration Properties section, then double-click the property’s
Value eld.

a. To change the value for a property with a string or numeric type, enter the numbers or text you want for
the property’s value.

b. To change the value for a property with a Boolean (yes/no) type, select or clear the check box that is
displayed.

9. To specify dierent property values for another interface, select the interface and repeat step 7.
10. To specify dierent property values for another prole, select the prole and repeat step 7.
11. To automatically apply the property values you specied to other proles and interfaces, click Apply, then

select the appropriate option.
a. To apply the property values to all interfaces for the prole, select Apply this Conguration to All

Interfaces for the Selected Prole.
b. To apply the property values to all proles and interfaces, select Apply this Conguration to All Proles

and Interfaces.
12. To automatically remove customized property values from proles and interfaces, click Restore and select the

appropriate option.
a. To reset the values for all proles and interfaces, select Restore the Default Conguration to All

Proles and Interfaces.
b. To reset the values for all interfaces enabled for the selected prole, select Restore the Default

Conguration to All Interfaces for the Selected Prole.
13. Click Save to save your changes. stu {more stu}

Install an Updated Add-In  
If you edit or replace les used for an add-in you have previously installed, you need to update the add-in in the Add-In
Manager.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Add-In Manager.

The Add-In Manager opens on the content pane.
3. Click the name of the add-in you want to update.
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4. Click Update.

Note:  When the Open window initially displays, only .dll les appear. To view .zip les, click the Files
of Type drop-down menu and select Compressed Add-In Files.

5. Select the add-in’s updated le, then click Open. The display is updated to reect any changes from the
updated add-in le.

6. Make any edits to the add-in that you need.
7. Click Save to save the change.

Remove an Add-In  
You will sometimes need to remove add-ins that you no longer use from your site. This is done using the Add-In
Manager. You cannot remove add-ins when an upgrade test site exists.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Add-In Manager.

The Add-In Manager opens on the content pane.
3. Click the name of the add-in you want to remove.
4. Click Delete.
5. Click Save.

View the Audit Log for an Add-In  
The audit log displays the type of action performed on the add-in, the sta member who made the change, when the
action occurred, and where on the administration interface the action was performed.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Add-In Manager.

The Add-In Manager opens on the content pane.
3. Click the name of the add-in you want to examine.
4. Click the Audit Log buon on the ribbon. The Audit Log window opens.
5. Click X on the top right to close the window.

Use Add-Ins in Scripts and Workspaces  
After you upload an add-in, you can place it in scripts and workspaces. This functionality can be added in several ways,
depending on how the add-in is wrien.

If the add-in includes functionality to accept information from rule and branch conditions, you can congure script
branches and script and workspace rules to send information to the add-in and perform actions based on the add-in’s
response. For instance, if your organization handles customers whose products are still under warranty dierently than
customers with expired warranties, you could create a script branch that opens one script page if a customer’s product
is still under warranty and another page if it is not.
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The add-in can be displayed anywhere you want on the script or workspace, or you can hide it using functionality in the
script and workspace designers. You can also congure script branches and script and workspace rules to communicate
with the add-in. We provide a script example here.

1. Add a custom eld to your script where customers enter their product’s serial number.
2. Place an add-in on the script that compares the value entered in the custom eld to a list of serial numbers that

are under warranty.
3. Create two script branches that branch to dierent pages on the script.
4. Congure the branches to re when the customer clicks the Next Page buon on the script’s navigation panel

(or when another action is taken).
5. Create one If condition for each branch that is checked when an add-in’s control condition returns a certain

value.
6. When you edit the conditions, you can enter the information you want to send to the add-in in the Add-In

Parameter eld.
In this example, you send the custom eld’s ID number to the add-in. The add-in would then nd the value
entered in the custom eld on the script and compare it to an external database that contains serial numbers
that are under warranty.

7. Set dierent operators and values for the conditions in each branch.
a. If you want the add-in to return true when it nds the serial number in the external database, set the

operator to equals and the value to true.
b. Set the other branch’s operator and value to equals and false.

Using this conguration, one branch is triggered when the add-in nds that a serial number is under warranty, and the
other branch is triggered when the add-in nds it is not under warranty.

Using script or workspace rules, you could further expand this example to update the external database with the serial
number entered on the script when other conditions are met.

View Add-In Log Messages  
After add-ins are installed, you can view log les of the activity related to add-ins you use or that you have added or
deleted from the Add-In Manager.

Add-in logging is particularly useful for add-in developers or administrators who need to test or troubleshoot add-ins.
You can also view which add-ins are enabled for your prole that might impact the behavior of the Service Console. All
messages on the Log Messages window are removed when you log out of Oracle Service Cloud. However, you can save
the messages for later viewing or remove the messages without logging out of the application. These options apply
only to the messages displayed on the window’s active tab.

Note:  The entries on the Log Messages window are deleted when you log out of the administration interface.
In addition, the messages are unique to your session and do not include messages related to other sta
member sessions. However, you can save the messages to text les for later viewing.

1. Click File and then select Add-In Logging.
a. To view the current log le, select View Current Log File.
b. To view the previous log le, select View Previous Log File.

The Log Messages window opens. Two tabs are available on the window. The Log Messages tab shows only
messages you choose to see, and the In Memory Log Messages tab displays all messages related to your add-
in activity during your current session. Each message is associated with one of these message types.
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Message Type Description

Error Error messages describe problems add-ins encounter that prevent them from working
correctly.

Warning Warning messages describe possible issues that may prevent add-ins from working as
expected.

Information Information messages describe events that happen to add-ins, such as when they are
activated or deleted on the Add-In Manager.

Verbose Verbose messages describe the ow of add-in actions, such as when an add-in executes
an action. These messages are not displayed on the In Memory Log Messages tab.

Activity Tracing Activity Tracing messages provide additional details about add-in activity, such as the
amount of time it takes to execute an add-in action. These messages are not displayed
on the In Memory Log Messages tab.

2. To view only certain types of messages or messages pertaining to certain activities, click the Log Messages tab
and then select which message types you want to view from the drop-down menus.

Drop-down Menu Description

Activation Logger Message types in this drop-down menu are wrien to the log le when add-ins are
activated or initialized. Entries will also be wrien when initialization fails or an exception
occurs during activation or initialization.

Distribution Logger Message types in this drop-down menu are wrien to the log le when add-in les are
uploaded, updated, or removed.

Component Logger Message types in this drop-down menu are wrien to the log le by active add-ins that
use the IGlobalContext.LogMessage API.

Usage Logger Message types in this drop-down menu are wrien to the log le when add-ins are used.
The specic entries wrien to the log vary depending on the add-in functions.

3. To remove log messages you do not want to see, select the tab showing the messages and then click Clear
Messages.

4. To save the log le to a text le you can open for later viewing using a third-party text editor, select the tab with
the messages you want to save and then click Save Messages.
A window opens where you select the location and name of the text le containing the log messages.

View Add-Ins Enabled for Your Prole  
The add-ins that are enabled for your prole can impact the behavior of the Service Console.

Therefore, you will want to view lists of the enabled add-ins to see which ones you can access on the interface to which
you are logged in, and add-ins that are not applicable to the current interface.

1. Click File and select  Options > Add-Ins .
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The list showing the add-ins enabled for your prole displays on the right. The list displays four columns of
information showing the le name, display name, mode, and version number of each installed add-in. The
mode can be either production or development. Add-ins in production mode were installed using the Add-
In Manager. Add-ins in development mode were manually added to the workstation, generally for testing
purposes.

2. Click OK to close the list.

Agent Browser UI Extensions  
You can import Agent Browser UI Extensibility Framework les into Oracle Service Cloud to create extensions by using
the Add-In Manager.

You use this process:

1. Create custom content to display on the Agent Browser UI by using the extensibility framework. See Agent
Browser UI Extensibility Framework Developer Guide.

2. Create an extension by using the Add-In Manager. See Overview of Agent Browser UI Extensions in
Administering Agent Browser User Interface.

Download Add-Ins and Extensions  
You can download add-in and extension les from the Add-In Manager by using the Download buon on the ribbon.

Files must rst be saved in the Add-In Manager before they can be downloaded.

Downloading add-in and extension les let you troubleshoot any errors that might occur in using these les. You can
also use the download capability to import add-ins and extensions to other sites.

1. In the Add-In Manager, select the add-in or extension that you wish to download.
2. Click Download on the ribbon.
3. In the Save As window, select a location to save the add-in or extension, then click Save.

Add-ins are saved as .zip archives.
Extensions that consist of a single le, such as .js or .json, are saved as the le itself. Extensions that contain multiple
les are saved as .zip archives.

Multiple Interfaces  

Overview of Multiple Interfaces  
When you use multiple interfaces, each interface can be a unique conguration of the data in your installation’s single
knowledge base.

Each installation of Oracle Service Cloud initially contains one knowledge base and one interface. The knowledge base
contains all the data needed to run Oracle Service Cloud and organizes it in a meaningful way by connecting the related
components, such as products, answers, and sta accounts. The interface, on the other hand, is designed solely to
display the data stored in the knowledge base.
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Multiple interfaces let you apply a unique conguration of your data to each interface in your installation’s single
knowledge base. For example, you might want an interface for your retail customers that is dierent from the one for
your corporate customers. You may need Spanish- and French-language sites in addition to your primary English-
language site to serve all your North American customers. Or perhaps your company produces dierent product lines
and you want to create an interface for your medical electronics customers that is dierent from the one you use for
your computer system customers.

In addition to oering multiple customer sites, you can also control how information is displayed on the agent desktop.
Using visibility seings for specic elds in each interface, you choose what can be viewed by your sta members.

Additional interfaces are cloned from the original, or primary interface. The new interface is then congured separately
from the primary interface. The process is the same regardless of the number of interfaces that have already been
created.

Note:  When you create customer portal pages for multiple interfaces, you must set up each one separately.
See Conguring Oracle Service Cloud for Customer Portal.

Alternatives to Multiple Interfaces  
Before conguring multiple interfaces, you should consider whether that solution best addresses your organization’s
needs since other options may be more appropriate.

• Multiple knowledge bases—If your organization has sensitive information that you do not want to share across
interfaces, you might want to consider using separate knowledge bases rather than multiple interfaces. When
using multiple interfaces, many records on the agent desktop can be viewed by all sta members, including
those with access to just one interface. For example, agents with permission to view contacts can view all
contacts, regardless of the interface. Using separate knowledge bases lets you oer dierent support sites, just
as you can with multiple interfaces, but the installations are completely separate and each site has a unique set
of data.

• Privileged Access—If you want only to grant varying levels of information to dierent groups of customers but
do not have sensitive information and do not require a unique conguration for each interface, consider using
privileged access rather than multiple interfaces. You must set the ANS_PRV_ENABLED conguration seing to
Yes in order to enable privileged access to answers. This seing is located in the Conguration Seings editor in
RightNow User Interface/End-User Interface/Answers. See Edit a Conguration Seing.

Note:  Contact your Oracle account manager for information about multiple knowledge bases.

Interface Options and Seings  
When you clone an existing interface, the new interface is initially identical to the original interface. You must make
changes to the cloned interface so that it presents the information you want in the format you want it to display.

It is important to understand how all interfaces are aected by changes you make to a single interface. Some changes
appear on all interfaces regardless of the interface where you created or changed them. Some changes appear only on
the interface where you make them. And still other types of changes appear only on the interfaces you select.
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Note:  The conguration and analytics items in the following lists are displayed beneath their default locations
on the navigation pane. However, they may display in dierent locations or not at all depending on your
navigation set conguration. The lists also display common and interface-specic record types.

Common Items and Seings  
Certain items and seings are shared across all interfaces and are not interface specic. Therefore, when you add or
change one of the items on one interface, it automatically appears on the other interfaces.

For example, sta accounts added while logged in to one interface can be viewed and edited from any interface.

The following items are common across all interfaces.

Conguration

• Sta Management

◦ Accounts

◦ Password Conguration

◦ Proles

• Application Appearance

◦ Client Workow Images

◦ Customizable Menus (Answer Statuses, Asset Statuses, Billable Tasks, Chat Agent Statuses, Chat
Session Queues, Contact Roles, Contact Types, Incident Queues, Incident Severities, Incident Statuses,
Opportunity Statuses, and Organization Address Types)

• Site Conguration

◦ Distribution Lists

◦ Mailboxes

◦ Process Designer

◦ Rules

◦ Site-specic conguration seings

◦ Site-specic message bases

• Internationalization

◦ Countries

• Service

◦ Answer Stopwords

◦ Channels

◦ Guided Assistance

◦ Service Level Agreements (SLAs appear on all interfaces. However, you must set the response
requirements separately for each interface.)

◦ Social Monitor

• Opportunity Tracking
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◦ Product Catalog

◦ Sales Periods

◦ Strategies

• Outreach

◦ External Suppression List

• Database

◦ Data Dictionary

◦ Object Designer (custom objects)

◦ Incident Thread Correction

◦ Data Import Template

◦ Data Import Wizard

◦ Email Address Sharing

Analytics

• Report Styles

• Chart Styles

• Color Schemes

• Report Images

• Text Fields

Record types

• Contacts

• Organizations

• Tasks

• Standard reports

• Incidents

• Answers

• Opportunities

Interface-Specic Items and Seings  
In contrast to common items and seings, others are unique to an interface and impact only the interface they are
congured on.

For example, to create a survey, you must log in to the interface from which the survey will be used. These items are
indicated in the following list.

Other items and seings, such as message bases, are interface specic, but can be congured from any interface.
Before conguring the item or seing, you select the interface you want to congure.

Conguration

• Application Appearance
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◦ Navigation Sets—Can be congured only for the logged-in interface

◦ Scripts—Can be congured only for the logged-in interface

◦ Workspaces/Workows—Can be congured only for the logged-in interface

• Site Conguration

◦ Customer Portal

◦ File Manager

◦ Interfaces

◦ Interface-level conguration seings

◦ Interface-level message bases

◦ Message Templates

• Service

◦ External Search Conguration—Can be congured only for the logged-in interface

◦ Incident Stopwords—Can be congured only for the logged-in interface

◦ Response Requirements

◦ Search Priority Words—Can be congured only for the logged-in interface

◦ Topic Browse

◦ Variables

• Opportunity Tracking

◦ Promotions—Can be congured only for the logged-in interface

Record types

• Custom reports—These are congured from the interface they display on, but can display data from multiple
interfaces. See Export a Report Denition to an XML File to learn about copying reports from one interface to
another.

• Audiences

◦ Contact Lists

◦ Segments

• Campaigns

• Content Library

◦ Documents

◦ File Aachments

◦ Snippets

◦ Templates

• Mailings

• Questions

• Surveys
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• Tracked Links

Options with Interface Visibility Seings  
There is another set of options that may be shared across interfaces, but only if you set the visibility seing of the
option to appear on the selected interfaces.

The following list includes those options that can be visible on other interfaces if you set them to appear on the specic
interfaces.

Conguration

• Application Appearance

◦ Customizable Menus (Answer Access Levels, Competitors, Industry Types, Lead Rejection Types, and
Win/Loss Reasons)

• Site Conguration

◦ Add-in Manager

◦ Logs

• Internationalization

◦ Currencies/Exchange Rates

• Service

◦ Holidays

◦ Products/Categories/Dispositions

◦ Standard Text

• Opportunity Tracking

◦ Product Catalog

◦ Price Schedules

◦ Quote Templates

◦ Territories

◦ Strategies

• Outreach and Feedback

◦ Tracked Link Categories

• Database

◦ Custom Fields

When to Use Multiple Interfaces  
The decision to use multiple interfaces depends on what you want to accomplish with each interface.
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The following list summarizes the procedures involved in creating and conguring an additional interface. After you
have completed the rst two procedures, you need to decide which of the remaining procedures listed in this section
you need to implement. Your decision depends on what you want to accomplish, but it is likely that you will want to
implement many, if not all of them.

1. How You Determine Interface Needs—Decide how your sta and customers are going to use the new interface
to determine how it must be congured. Your Oracle account manager can assist you in dening your
objectives.

2. Change the Interface Display Name—Change the interface name that appears on the agent desktop.
3. Sta Member Accessibility—Use navigation sets, workspaces, and proles to establish the interfaces sta

members have permission to access and work on.
4. How You Manage Visibility in Conguration Items—Customize conguration items with specic visibility

seings such as custom elds and products.
5. How You Congure and Customize the Interface —Customize the interface-specic conguration seings for

each new interface through the Conguration Seings editor.
6. How You Manage Multiple Interfaces by Creating Business Rules—Dene rules to automatically assign incidents

and opportunities to the proper interface and queue or sta member.
7. How You Congure Mailboxes for Multiple Interfaces—Customize your Service and Outreach mailboxes for each

interface.
8. How You Customize Message Templates for Multiple Interfaces—Customize the notications and emails that can

be sent to your sta members and your customers from each interface.
9. How You Add Answers for Multiple Interfaces—Determine the content you want to provide to your customers

through the customer portal and create your answers.

How You Determine Interface Needs  
When you clone an interface, the new interface is a duplicate of the original interface and has the same customized
conguration.

For this reason, we recommend waiting to clone your interface until you complete conguring the original interface.
This can help reduce the amount of customization you need to do on the cloned interface, particularly if you want the
interfaces to be similarly congured.

Before you clone interfaces, you should consider how your sta members and customers will use the new interface
and what changes you need to make to accomplish the intended purpose. As a starting point, consider whether the
language will change, whether the new interface needs to send and receive email, what custom elds and customizable
items you want to appear on the new interface, which conguration seings (site or interface specic) and message
bases need to change, and whether you can use business rules to manage the new interface.

Note:  Because conguration seings and message bases are categorized as site or interface specic, it’s
critical to know which seings will aect all interfaces (site specic) and which ones will aect only one
interface (interface specic). Since there are fewer site-specic seings, it is easier to identify those by
searching for all site-specic seings on the Conguration Seings editor. Using this search criterion, you can
easily see which seings are applied across all interfaces and decide what is best for your situation. See Search
for a Conguration Seing and Search for a Message Base.

Also consider what level of access your sta members and customers should have to the new interface to determine if
you need to modify proles or recongure customer portal pages. You should also identify who, if any sta members
besides you, will have administration permissions on all interfaces. Ideally, a limited number of administrators have
access to all interfaces. If you have a large number of administrators, it can be challenging to prevent unwanted
additions or deletions of elds or items that aect the incorrect interface.
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While performing this step, start thinking about naming conventions for your sta accounts, proles, customizable
menus, and custom elds. For example, the names you select for proles congured for an internal interface could
begin with “internal” to make it easier to identify the proles that belong to the interface.

Change the Interface Display Name  
You may decide you want to change the name of the interface as it displays for sta members.

Changing the interface name aects only the display of the interface name as it appears to sta members on the agent
desktop. URLs to your interface continue to use the original interface name.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Interfaces.
3. Click the interface name you want to edit.
4. Enter the new interface name in the Display Name text box.
5. Click Save.

Note:  To change the answers report that displays on the Answers page of your customer portal, see
Overview of the Answer and Question Details Pages.

Sta Member Accessibility  
There are three components that aect how your sta members access your interfaces: navigation sets, workspaces,
and proles. To present the appropriate information to sta members, and allow access to only those interfaces and
features required by your organization, it is important to understand how the components work together.

Related Topics
• Navigation Sets in Relation to Multiple Interfaces

• Workspaces in Relation to Multiple Interfaces

• Proles in Relation to Multiple Interfaces

Navigation Sets in Relation to Multiple Interfaces  
By selecting proper reports for each navigation set, you can limit the results for sta members to the interface they
primarily work from.

For example, you may want to set the incidents reports that display in the navigation list to only those reports that lter
by a particular interface. See Create a Navigation Set.

Navigation sets dene what appears to sta members on the agent desktop. In addition to the buons on the
navigation pane, you can determine which reports sta members can access and which appear by default when the
console opens or a navigation buon is clicked.

After your navigation sets are congured, you can assign them to proles. See Proles.

Workspaces in Relation to Multiple Interfaces  
Workspaces can help dene how sta members use your interfaces. Since each prole uses separate workspaces for
each interface, you can create dierent workspaces to accommodate sta members who use dierent interfaces.

For example, sta members who log in to an interface used by external customers may use a contact workspace that
includes the contact rst name and last name elds. Sta members who log in to an internal interface may use a
contact workspace that shows only the contact email address eld. By using dierent workspaces on each interface, you
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can display only those elds sta members need to view or ll in on that particular interface. After your workspaces are
created, you can assign them to the necessary prole. See Custom Workspaces.

Proles in Relation to Multiple Interfaces  
When you clone an interface, all proles with permission to access that interface automatically have permission to
access the new interface. If you do not want certain proles accessing the cloned interface, you must edit the prole
seings to remove that permission.

Each sta member is assigned a prole that determines which interfaces the sta member can access. Proles also
determine the queues sta members can pull incidents from, so you must ensure that the prole can access the
appropriate interfaces.

In addition, you can specify the navigation set and the workspaces sta members use through their prole. For each
prole, you can specify the navigation set used on each interface, as well as the workspaces used for each record type
on each interface. See Add or Edit a Prole.

How You Manage Visibility in Conguration Items  
You can specify the interfaces where certain conguration items appear, while others are visible across all interfaces.

Those items visible on all interfaces are listed in Common Items and Seings. When you add one of these items to
your interface, it appears on all interfaces. For example, if you add a custom incident status, sta members working on
incidents from any interface can set an incident to that status.

Other conguration items, such as custom elds, contain visibility seings for selecting the interfaces on which they
appear. These items are listed in Options with Interface Visibility Seings. Some of these let you select the interfaces
and others let you specify not only the interface, but also whether the item is visible on the customer portal or the agent
desktop. If you have separate customer portal pages for dierent product lines, for example, you will likely want to
restrict sales products to unique interfaces so that they appear only on the appropriate site.

To specify the interfaces where you want the conguration item to appear, simply select the check boxes for each
interface.

In a multiple language installation, you can specify that conguration items appear on all interfaces but change the
name for each interface to show the translated version of the item. You do this by logging in to the proper interface and
entering the foreign language word in the Label eld.

How You Congure and Customize the Interface  
Each interface has its own conguration seings. When you cloned your interface, any customized conguration
seings were copied to the new interface. You must manually adjust any conguration seings that should be changed
for the new interface.

For example, you may choose to let customers ask a question on one interface but not the other. See How You
Customize Conguration Seings.

Note:  For conguration seings specic to the customer portal, see Customer Portal Conguration Seing
Keys.

How You Manage Multiple Interfaces by Creating Business Rules  
When you create rules for multiple interfaces, you must be aware of the visibility seings for your custom elds and
customizable menu items.
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The rules engine can access all custom elds and customizable menu items regardless of their visibility seings, so
all conditions and actions that use those elds and items are available to you, even if they cannot be displayed on the
interface. See Options with Interface Visibility Seings for a complete list of options.

Because the rules engine does not lter elds and menu items based on their visibility on the interface, you run the risk
of seing a eld or menu option that is not visible. To prevent meaningless actions and ensure that the rules engine
sets the eld or menu item you want it to, you can specify the interface as one of the rule conditions when you create
incident, chat session routing, opportunity, and target rules. And, if the object meets certain conditions, you can use a
rule action to set the interface to a dierent one for rule processing.

It is important that an object be processed on the correct interface because the rules engine uses the message bases
and conguration seings of the interface associated with the object. For example, if you try to use an English-language
interface to process an incident that was sent in German, any message bases used to respond to the incident will be in
English. For that reason, it is important that objects be processed on the correct interface. Fortunately, rule actions let
you set the interface when the rule conditions are met.

And although you cannot set the language or mailbox in a rule action, you can use them as conditions to set the
interface in the rule. Assume, for example, you have two interfaces: one English-language interface and one German.
Also assume that Techmail is scheduled to run only on the English interface. While you cannot change an incident
language to German in a rule, you can change its interface. And, because the interface uses the message bases of the
interface processing the rule, changing the interface accomplishes the same results.

The following rule demonstrates this:

If Incident.Language equals German
Then Set Interface Name to german_interface

See Overview of Business Rules. For examples of commonly used business rules, see Examples of Business Rules.

How You Congure Mailboxes for Multiple Interfaces  
If you have Oracle RightNow Cloud Service (Service) enabled, you must create at least one Service mailbox for the new
interface in order to send and receive email. If Outreach or Feedback is enabled, you must create at least one Outreach
mailbox to create and send mailings and surveys.

If you have multiple mailboxes for the interface, you must specify a default Service mailbox and a default Outreach
mailbox. Even though you can congure your interface to send email from a single address, if you have multiple
mailboxes, you must congure each mailbox separately. However, you can congure mailboxes for all interfaces, from
any interface, using the Mailboxes editor. See How Mailboxes Work.

Note:  To ensure accurate processing of replies, inbound messages, and bounces, Outreach mailboxes cannot
be shared with either type of Service mailbox (Oracle-managed Service or general Service). Techmail handles
messages in Service mailboxes dierently from how it handles them in Outreach mailboxes. For this reason,
you must set up one mailbox for Service and a separate mailbox for Outreach and Feedback.

Distribution lists are not interface specic so any distribution list you add on one interface is available on all other
interfaces. See Add or Edit a Distribution List.

How You Customize Message Templates for Multiple Interfaces  
You may want to change the notications, emails, and print templates that can be sent to your sta members and your
customers from each interface. You may also want to change the content that is sent by interface.

Message templates let you dene the format of your messages and disable certain messages if they do not pertain to
an particular interface. You can also customize your logo, your headers and footers, and your message content. For
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example, if you have a parent company with multiple subsidiaries, each with a unique brand, the look and feel of each
interface can be dened using the global template. The global template is then applied across every single message that
is enabled on that interface. See How the Message Templates Editor Works.

How You Add Answers for Multiple Interfaces  
When you create answers to populate your knowledge base, you need to think about which interfaces you want them to
appear on and then associate each interface with the proper answer access level.

For example, you could create two custom answer access levels, Internal and External, each with visibility on dierent
interfaces. Answers with the Internal access level would display on only the interface used by your organization’s
employees. Answers with the External access level would display on only the interface used by your external customers.
To have the answer appear on both interfaces, select the access level Everyone.

Although we recommend that you use answer access levels as the key element for determining answer visibility, there
are other ways to control where answers are displayed and who can view them. Here are the other methods you can use
to control the display of answers.

Item Method

Answer Access Levels
 

Select the interface you want the access level to display on.
 

Products and Categories
 

Select the interfaces where each of your products and categories are visible.
 

Answer Statuses
 

Select the Public answer status type to display answers on the customer portal. All other types restrict
the display so customers cannot see them.
 

Languages
 

Create the answer on a language interface to restrict the answer display to that language.
 

Conditional Sections
 

Insert a section with certain visibility restrictions within an answer.
 
If a section of the answer is assigned an access level that is not visible to customers on a particular
interface, but the answer is visible, then customers can view the answer but not the conditional section.
See Insert a Conditional Section.
 

Common Functionality  

Overview of Common Functionality  
Oracle Service Cloud is designed for eciency by making procedures as similar as possible.

When you know how to aach les to an incident, for example, you can use that knowledge to aach les to any kind of
record. By understanding common functionality, you improve your condence and eciency when working in Oracle
Service Cloud.

Common functionality applies to searching, opening, forwarding, copying, printing, assigning, agging, and aaching
les to dierent types of records. Also common to Oracle Service Cloud are standard workspaces, audit logs, spell
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checking, workgroups, Outlook appointments, and notications. Because the majority of common functions are
performed using the ribbon, it is important that you rst become familiar with it.

Common Functionality Ribbon  
All items that appear on the content pane—reports, explorers, and records—display a ribbon at the top of page, just
below the Oracle logo buon at the top left of the console.

The ribbon has tabs and buons that let you work with a report, an individual record in the report, or an item in the
explorer tree. Buons are organized into groups, and each tab may include several groups.

Click any ribbon tab to display the buons for that tab. Or, with your mouse or other pointing device positioned
anywhere in the ribbon, scroll down to move one tab to the right. Scroll up to move one tab to the left.

Some buons on the Home tab contain an arrow, including Open, New, Print, Copy, Assign, and Delete. Clicking the
arrow rather than the buon displays a list of associated records you can take the action on instead of the incident,
which is the default record that the action applies to. For example, if you click Open, the incident that you have selected
on the content pane opens. If you click the arrow on Open, a menu displays the records you can open (incident, contact,
organization, or mailing) that are associated with the selected incident.

Some tabs, buons, and groups always appear on the ribbon no maer what is displayed on the content pane. Others
are content dependent. That is, they change to reect what appears on the content pane and the allowable actions for
that report, explorer item, or record.

Note:  If nothing opens on the content pane when you log in, the ribbon is empty except for the Home tab. See
Change Your Navigation Pane Seings to see how to dene what opens on the content pane when you log in.

When you want to display a larger section of a report and do not need access to the ribbon, you can easily minimize it.
You will still have access to the tabs and buons you need.

• To minimize the ribbon, double-click any tab with focus or press Ctrl+F1.

• To restore the ribbon, double-click any tab or press Ctrl+F1.

• To display and click buons on a tab without maximizing the ribbon, just click that tab.

Customize the Quick Access Toolbar  
The Quick Access toolbar, which appears next to the Oracle logo buon at the top left of the console by default,
provides shortcuts to commands on the ribbon.

The initial set of buons on the Quick Access toolbar is specied by what is displayed on the content pane, but you can
customize the toolbar to add buons you frequently use. (The customized toolbar is stored in local seings on your
workstation. See Change Your Personal Seings.)

Tip:  Some ribbon content cannot be added to the Quick Access toolbar, including check boxes, combination
boxes, text elds, and some other input elds.

1. To add a buon to the Quick Access toolbar, right-click the buon on the ribbon and select Add to Quick
Access Toolbar.

2. To add a content-dependent or global option on the le menu to the Quick Access toolbar, click File, right-click
the option on the left panel of the le menu, and select Add to Quick Access Toolbar.
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3. To remove a buon from the Quick Access toolbar, right-click the buon on the toolbar and select Remove
from Quick Access Toolbar.

4. To move the Quick Access toolbar from above the ribbon to below the ribbon, click the drop-down buon on
the Quick Access Toolbar and select Place Quick Access Toolbar Below the Ribbon.

5. To reset the Quick Access toolbar to its default seings, click the drop-down buon on the Quick Access Toolbar
and select Reset Quick Access Toolbar to default.

Display Shortcut Keys on the Ribbon  
Shortcut keys are available for all ribbon buons so you can enter a key combination to perform an action rather than
clicking a buon on the ribbon.

1. While editing a record or working in an explorer, press Alt plus the rst leer of the ribbon tab that you want to
display shortcut keys for. For example, press Alt+H to display the shortcut keys on the Home tab of the ribbon.

2. Enter the keys associated with a particular buon to perform the buon’s action.
After using this method to perform an action, the shortcut keys no longer display. See Shortcut Keys.

Record Search Options  
One way to nd a specic record when a report is open is by scanning the list of displayed records to see if you can spot
it.

Oracle Service Cloud oers other much more ecient methods of searching for records. Besides simply looking in a
report for a record, you have the following search options.

• Search for a Record from a Report—If you do not immediately see the record you want in the report, you can
search for it. The lters that appear when you click Search depend on the report and which lters have been
dened for it.

• Overview of Quick Search—With the Quick Search component, you can search for a specic record by entering
as much or as lile information about the record as you have. The list of records that match the information you
enter is displayed, and you can select the one you want.

• How You Search from Open Records—You can search for contacts and tasks from any open record that has a
contact or task associated with it. You can also search for organizations from some types of open records.

Related Topics
• Finding Incidents (video)

Search for a Record from a Report  
Reports can be used to display lists of records. When you open a report, you can easily search for a record from that
report.

Double-click any report in a navigation list to display a list of records in the report on the content pane. (The reports in
your navigation lists are determined by the navigation set assigned to your prole.) The information displayed on the
content pane depends on the report you selected and which elds were dened when the report was created.
When you search for records using the report Search function, you can identify records that meet the criteria you
specify. For example, you can search for incidents assigned to a certain sta member, answers that contain particular
words or phrases, or tasks that are due this week. You can then sort your search results in ascending or descending
order based on any of the lters you used for searching.

1. With a report displayed, click Search on the Home tab of the ribbon. A Search window opens, displaying the
search lters that are available for that report. (Each report uses the lters specied in the report denition.)
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Tip:  You can resize the Search window to display all of the lters available for a given report. The size
of the Search window is retained until you resize it again or reset the workstation local seings. See
Change Your Personal Seings.

2. To specify a lter that has a check box, select the check box next to each lter you want to use in your search or
clear the check box for those you do not want to use.

3. To specify a date lter, click the calendar buon in the eld to display the current month’s calendar. Then select
the date. (Use the arrows at the top of the calendar to change the month if necessary before selecting the date.)

4. To specify a text lter, enter text in the eld. You can use an asterisk (*) as a wildcard in your search term.
a. When you are searching for answers, you can use the search text type elds Phrases, Similar Phrases,

Exact Search, Complex Expression, or Answer ID. See Answer Text Field Search Options.
5. To limit the number of records returned in the search, select the Limit To check box and enter a number in the

Rows eld. The total number of search results is restricted to this value. If the Limit To check box is cleared, the
search results are unlimited.

6. To limit the number of records returned per page to the number specied in the Rows eld, select the Per Page
check box. Instead of the total number of search results being limited to the value in the Rows eld, every page
will return that number of results.

7. To establish the order for sorting search results, click the text in the Order By eld. The Sort window opens.
a. Select the primary eld you want to sort by from the Sort Items By drop-down menu.
b. To sort by the selected eld in ascending order, select Ascending. To sort in descending order, select

Descending.
c. To sort on additional elds, select the elds to sort on from the Then By drop-down menus. When you

dene multiple sort elds, the records are initially sorted by the rst sort eld. If any of the records have
the same value for the rst sort eld, those records will then be sorted by the subsequent sort elds.

d. To remove all sort options, click Clear All.
e. Click OK.

8. To save your selections as default search lters for the report, click Seings and select Save as Default Values.
9. To restore the lters to the default seings for the report, click Seings and select Restore Default Values. You

can also restore the defaults from the Personal Seings option. See Change Your Personal Seings.
10. To reset the current selection criteria to their default values that were populated when the report was opened,

click Seings and select Reset Values.

Tip:  You can customize the Search window layout in the report you are using, and save it to your
local workstation so you will see the same lter positions, sizes, and ordering when you next open the
report. See Overview of Custom Reports.

11. Click Search to display the records that match your search criteria.

Related Topics
• Special Characters Allowed When Searching

Answer Text Field Search Options  
When you are searching for answers, you can use the search text type elds Phrases, Similar Phrases, Exact Search,
Complex Expression, or Answer ID.

All search types look for dierent word forms such as singular, plural, or dierent verb tenses. For example, searching
for reect will nd answers that contain reection, reections, reected, reecting, or reects.

All search types use the logical operators + (AND) and – (NOT). Insert + before a word to nd answers that must include
the word. Insert – before a word to exclude answers containing that word. For a list of special characters that can be
used for searching, see Special Characters Allowed When Searching.
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The answer Summary, Question, Answer, and Keywords elds are searched for matching terms.

Field Description

Phrases Select this search technique to search for answers containing the words in the phrase or question you
enter. Multi-word phrases usually produce beer search results.

Similar Phrases Select this search technique to search for answers that contain the words or phrase you enter as well as
answers containing synonyms for the words you enter.

Exact Search Select this search technique to search for answers with the same paern of words as the words you
enter. Only answers containing an identical paern of words are matched, although the words in the
matching answers may be separated by stopwords such as a, an, or the.

Complex Expression Select this search technique to search for answers containing the complex expression you enter. This
technique allows wildcard searching using an asterisk (*) at the end of a word or partial word and a
tilde (~) before a word to perform a similar phrases search on that word only.

Answer ID Enter a range of answer IDs to search for answers with answer IDs within the specied range. Wildcard
characters are not supported in Answer ID searching.

Related Topics
• Search for a Record from a Report

Special Characters Allowed When Searching  
Oracle Service Cloud supports wildcard searching and also allows other characters to produce more accurate results.

Tip:  All of these guidelines apply when you are searching using a complex expression. When you are
searching using phrases, similar phrases, and exact search, only the following characters apply: + - _ / @ : < >
& and white space. Other punctuation is ignored and also acts as a word separator.

This table contains a list of the characters you can use, including how the characters are interpreted as well as the
importance of the placement of the characters in the text string. Also included is a list of invalid search characters.

Character Description

+
 

Always considered the logical operator meaning “must include.”
 

-
 

May appear in the middle of a word or number, but when it is placed at the beginning of a word or
number, it is always taken to mean “must not include.”
 

.
 

May appear in the middle of a word or number, but is otherwise considered punctuation.
 

_
 

May appear in the middle of a word, but is otherwise unrecognized.
 

/
 

May appear in the middle of a capitalized word or a number, but is otherwise considered punctuation.
 
And/or uses the / as punctuation to separate the word “and” from “or,” but I/O is recognized as a
single word.
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Character Description

@
 

May appear in the middle of a word, but is otherwise unrecognized.
 

*
 

Allowed only at the end of a word or number. It will act as a word separator otherwise. One exception is
that it is specically recognized as a leading character when directly preceding the @ to allow regular
expression searching of the sort: *@example.com.
 

:
 

Allowed within a number only. Otherwise, it is considered punctuation.
 

< >
 

Text enclosed within the angle brackets “<” and “>” is ignored. Otherwise, the angle brackets are
treated as punctuation.
 

&
 

Allowed as part of an embedded word, but is otherwise considered punctuation.
 

Whitespace (tab, return, space)
 

Ignored and acts as a word separator.
 

~
 

Allowed after a word to specify a broader search on the following word by using synonym expression
and spelling correction.
 

Overview of Quick Search  
Quick Search lets you access any record or le when you have only limited information about the item.

Quick Search is an ideal way to search the knowledge base no maer what navigation list is displayed or what is open on
the content pane. For instance, you could be working on a contact record and want to view an answer without changing
navigation lists. Using the Answer Quick Search report, which you can access from a drop-down menu on the Quick
Search tool window, just enter the answer ID and click Search. The answer opens on the content pane, and you can take
any action you need.

All Quick Search reports access data in the operational database instead of the report database to ensure that the most
current data is always returned. See Overview of Managing Reports on the Reports Explorer.

Note:  Oracle Service Cloud contains a number of predened Quick Search reports. The reports that appear
in the Quick Search drop-down menu depend on what reports were added to the Quick Search buon in your
navigation set. Additionally, if you have permission to customize your navigation set, you can add and remove
Quick Search reports as necessary. You cannot, however, add folders or other items to the list of Quick Search
reports. See How You Customize Navigation and Conguration Lists.

Search for an Answer with Quick Search  
You can use Quick Search to search for a variety of records, including answers.

1. Click the Quick Search drop-down menu on the Quick Search tool window and select Answer Quick Search.
You can also press F3 to make the Quick Search tool window active. If Quick Search is closed, pressing F3 will
open it in an undocked window.

2. Enter the answer ID and click Search. The answer opens on the content pane.

422



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Note:  Since the answer ID must match exactly, only one answer can match the answer ID you enter.
However, other quick search types let you enter just the rst few characters of the search term,
returning all records that match your partial search criteria on the content pane, where you can select
the record you want.

3. To perform another search, click Clear to clear the Answer ID eld.

Predened Quick Search Reports  
The elds that display when you change Quick Search reports are unique to the type of record or le you are searching
for.

Keep in mind that your list of Quick Search reports may be dierent from the reports described here.

Predened Quick Search Reports Description

Answer Quick Search Enter the answer ID.

Asset Search Enter the asset name, serial number, organization name, or contact name or select a service product
from the Product drop-down list.

Campaign Search Enter the campaign name.

Contact Quick Search Enter the contact’s last name, rst name, or email address.

Incident Search Enter the incident reference number.

Mailing Search Enter the mailing name.

Opportunity Search Enter the opportunity name.

Opportunity Tracking Task Search Enter the task name.

Organization Quick Search Enter the organization name.

Outreach Task Search Enter the task name.

Quick Search Dashboard Enter the incident reference number, contact name, organization name, or opportunity name.

Service Task Search Enter the task name.

How You Search from Open Records  
You can search for contacts, organizations, or tasks from many types of open records. For example, when you are
working on an incident, you might need to search for a contact to associate with the incident.

The following lists the types of searches you can do from various open records.

• Search for a contact from an open incident, opportunity, organization, task, asset, or contact list.

• Search for an organization from an open contact, incident, opportunity, task, or asset.

• Search for a task from an open answer, contact, incident, opportunity, or organization.

Make a practice of checking your recent items before searching. Just click the link in the eld next to the Search buon
to view a list of the records you’ve recently worked on, if any are available. If you nd the record you’re looking for, select
it. This is a quick way to associate a record, such as a contact, with an open record without having to conduct a search.
If you don’t nd the record you’re looking for, or if no records are available, then conduct a search using one of the
following procedures.
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This functionality applies only to incident, contact, organization, task, chat, asset, and custom object workspace types.
If the Show Recent Items in Fields check box is cleared on the View Options window, recent items will not display in the
search list.

Search for a Contact from an Open Record  
Search for a contact from an open incident, opportunity, organization, task, asset, or contact list.

1. Open the Contact Search window using one of the following methods:

◦ If you are working on an incident, opportunity, organization, or contact list, click the Contacts tab. Then
click Add Existing (or, for contacts lists, click Add Contact and select Add Existing).

◦ If you are working on an incident, opportunity, task, or asset, click Search to the right of the Contact eld.

2. Enter an entry in any of the available elds.

Tip:  You can use an asterisk (*) as a wildcard in your search term.The Recent Contacts section of the
Contact Search window also displays a list of recently opened contacts you can select.

3. Click the CX State drop-down menu and select from the following options (by default, all states are selected).

◦ Select All

◦ Service State

◦ Outreach State

◦ Opportunities State

4. Click Search. The contacts that match the search criteria are returned on the Contact Search window.
If only one contact matches the search criteria, that contact is automatically selected and the Contact Search
window closes.

5. Do one of the following:

◦ Select the contact you want to associate with the open record and click Select. The Contact Search
window closes and the contact appears on the Contacts tab of the record (for organizations and contact
lists), in the Contact eld (for tasks and assets), or both (for incidents or opportunities).

◦ If the contact does not appear in the list, click New Contact at the boom left of the window to open a
new contact subtab. Complete the elds and click OK.

When the new contact subtab opens, it is populated with any search terms you entered in the First Name, Last
Name, Email, Phone, and Postal Code elds in the Search window. If you are adding a secondary contact to
the record, the address and organization name elds (including Postal Code) are populated from the primary
contact’s organization.

Search for an Organization from an Open Record  
Search for an organization from an open contact, incident, opportunity, task, or asset.

1. On an open contact, opportunity, task, or asset, click Search to the right of the Organization eld. The
Organization Search window opens.

2. Enter the rst few characters of the organization’s name in the Organization Name eld. An implied wildcard is
used, so all organizations that begin with the leers you enter are returned in the search results.

Tip:  The Recent Orgs section of the Organization Search window also displays a list of recently
opened organizations you can select.

3. Click the State drop-down menu and select from the following options (by default, all states are selected).

◦ Select All

◦ Service State
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◦ Outreach State

◦ Opportunities State

4. Click Search. The organizations that match the search criteria are returned on the Organization Search
window.
If only one organization matches the search criteria, that organization is automatically selected and the
Organization Search window closes.

5. Select the organization you want to associate with the open record and click Select. The Organization Search
window closes and the organization appears in the Organization eld.

◦ Or, if the organization does not appear in the list, click New Organization to open a new organization
subtab. Complete the elds and click OK.

This procedure also applies when you want to search for and associate an organization on a new contact subtab
opened from the Contacts tab of an incident, opportunity, organization, or contact list.

Search for a Task from an Open Record  
Search for a task from an open answer, contact, incident, opportunity, or organization.

1. On an open answer, contact, incident, opportunity, or organization, click the Tasks tab.
2. Click Add and select Add Existing.

The Task Search window opens.
3. Enter the rst few characters of the task name in the Task Name eld. An implied wildcard is used so all task

names that begin with the leers you enter are returned.

Tip:  The Recent Tasks section of the Task Search window also displays a list of recently opened tasks
you can select.

4. Click Search.
The tasks that match your entry are returned on the Task Search window. If only one task matches the search
criteria, that task is automatically selected and the Task Search window closes.

5. Do one of the following:

◦ Select the task you want to associate with the open record and click Select. The Task Search window
closes and the task appears in the list of tasks on the Tasks tab.

◦ If the task does not appear in the list, click New Task to open a new task subtab. Complete the elds and
click OK.

Overview of Standard Workspaces  
You can work with dierent records when you are not actually changing the information in them. By understanding
standard workspaces and how to open, forward, copy, and print records, you will become more ecient while working in
the product suite.

Oracle Service Cloud provides a standard workspace for each record type (answers, assets, contacts, incidents,
opportunities, organizations, and tasks), plus a standard workspace for quotes, quote products, and service
opportunities on their respective windows. Oracle Service Cloud also contains standard chat workspaces for sta
members working in Oracle RightNow Chat Cloud Service (Chat). Each workspace denes the buons and tabs on the
ribbon, the buons on the Quick Access toolbar, which elds are available, what toolbars and buons are displayed on
record tabs, and how the information is organized on the content pane.
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Oracle Service Cloud also provides standard multi-edit workspaces for each record type. Each multi-edit workspace
denes elds for updating more than one record in a single operation instead of performing the same action on each
individual record.

Your organization may use the standard workspaces, or your administrator may have created one or more custom
workspaces. No maer which workspaces your organization uses, your prole contains a workspace for each record
type you have permission to access (and quotes, service opportunities, and chat workspaces, if applicable). Keep in
mind that the workspace your prole uses may display a dierent ribbon, dierent buons on the Quick Access toolbar,
a dierent combination of elds, or a dierent location for elds on the content pane.

Tip:  You can drag and drop record tabs to rearrange their order on each workspace. If you rearrange tabs,
the tab order for that workspace is stored in the local seings on your workstation until you reset the local
seings. See Change Your Personal Seings.

For information about working with specic records and a description of their standard workspaces, see any of the
following references.

• Organizations—See Overview of Organizations.

• Contacts—See Overview of Contacts.

• Tasks—See Overview of Tasks.

• Incidents—See Overview of Incidents.

• Answers—See Overview of Answers.

• Opportunities—See Overview of Opportunities.

• Assets—See Overview of Asset and Product Registration.

Open an Incident for Editing  
If your duties include responding to customers, publishing answers to your website, working with opportunities and
sending quotes to customers, or keeping customer information up-to-date, you can easily access information and take
the actions you need.

The procedure to open records is the same for all record types (incidents, answers, contacts, opportunities,
organizations, tasks, and assets).

1. Click Incidents on the navigation pane.
2. Double-click an incidents report. The report opens on the content pane.

Tip:  The default seing requires that you double-click an item to open it. However, you can change
the default so that items open with a single click. See Change Your Navigation Pane Seings.

You can zoom in and out of a report using the slider on the boom right of the content pane. Click the plus sign
to zoom in on specic details or click the minus sign to zoom out to see more of the report. You can also drag
the slider left or right to decrease or increase magnication.

3. Right-click an incident and select  Open > Incident . The content pane populates with the incident’s
information.

Additional ways to open a record include the following options.

◦ Selecting the record and clicking Open on the ribbon

◦ Clicking Open in the Action column
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◦ Double-clicking the record

Forward a Record  
There might be times when you need to forward an incident, opportunity, task, or asset. For example, you might need
information from another sta member before you can reply to a customer’s incident. Or maybe you need to forward an
opportunity for review and approval.

When you forward a record, you can forward any les that are aached to the record, send response les, and add
comments. You can also customize how the forwarded information is displayed. See How You Customize Messages. If
you are adding a record instead of editing an existing one, you must rst save the record before you can forward it.

1. Do one of the following:

◦ Right-click a record in a report and select Forward. The Forward window opens.

◦ With a record selected in a report, click Forward.

◦ With a record open, click Forward.

2. Enter eld information.

Field/Buon Description

To ...* Click this buon to open the Select Names window. Select the name of the recipient
and click To to insert the name in the eld. (To select additional recipients, press Ctrl
while making your selections.) After selecting the recipient, click OK on the Select
Names window. See Select a Recipient.
You can also enter the email address of the recipient in the text eld.
 

Cc ... Click this buon to open the Select Names window, select the recipient’s name, and
click Cc.
All recipients are able to see the email addresses in the Cc eld.
 

Bcc ... Click this buon to open the Select Names window, select the recipient’s name, and
click Bcc.
 
No recipients are able to see the email addresses in the Bcc eld.
 

Subject The subject for the incident, opportunity, task, or asset appears in this eld.

Send Contact Information Select this check box to send the primary contact information with the record. The
information that is sent includes the contact’s email address, rst and last names,
 contact type, title, any phone numbers that have been entered, and any custom eld
information.
This check box appears only if you are forwarding an incident.
 

Exclude Notes Select this check box to exclude any notes in the incident thread from being forwarded
with the incident.
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Field/Buon Description

This check box appears only if you are forwarding an incident. If this check box is
selected, the changes are retained when forwarding other incidents.
 

Incident Files Files that are aached to an incident you are forwarding are listed in this eld. Select the
check box next to any le you want to forward with the incident.
This eld is not visible when forwarding opportunities, tasks, or assets or if no les are
aached to the incident.
 

Opportunity Files Files that are aached to the opportunity are listed in this eld. Select the check box
next to any le you want to forward with the opportunity.
This eld is not visible when forwarding incidents, tasks, or assets or if no les are
aached to the opportunity.
 

Task Files Files that are aached to the task are listed in this eld. Select the check box next to any
le you want to forward with the task.
This eld is not visible when forwarding incidents, opportunities, or assets or if no les
are aached to the task.
 

Files Click Add Files and select Browse or Search to aach les to the email containing the
forwarded record. See Browse for a File to Aach to a Record or Search for a File to
Aach to a Record.
Files added in this eld are not added to the record.
 

Comment Enter any comments you want to forward with the record in this eld.
Text entered in the Comment eld will display as the body of the email that is sent to
recipients.
 

S/MIME Select one or both of the security options under S/MIME.
 

Sign Select this check box to sign the email with the mailbox signature.
The Sign check box is enabled only if the outgoing email is sent from a mailbox that has
a private key and certicate associated with it. See How SMIME Security Works.
 

Do not encrypt Click this drop-down menu and select one of the encryption options.

◦ Do Not Encrypt

◦ Encrypt When Possible

◦ Always Encrypt.

Encryption is supported if a destination email address has a public key associated with
it.
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Tip:  If you want to retain a copy of the record you forward, enter your email address in the Cc or Bcc
eld. This will let you reference comments and any aachments to the record you forwarded to the
recipient.

3. Click Send.

Related Topics
• Overview of Message Templates

• Select a Recipient

• Browse for a File to Aach to a Record

• Search for a File to Aach to a Record

Select a Recipient  
When you forward records, you can open the Select Names window from the To, Cc, and Bcc elds.

From this window, you can select from folders containing all currently enabled sta accounts, sta account groups,
distribution lists, and email addresses from all distribution lists.
If your administrator has not added distribution lists, the Distribution Lists and Addresses folders will not display. See
Add or Edit a Distribution List.

1. Click To, Cc, or Bcc to open the Select Names window.
2. To import your contacts from the default Contacts folder in Outlook, select the Load Outlook Contacts check

box. This is useful for displaying contacts that are not included in Oracle Service Cloud.
3. Select the name of the recipient and click To, Cc, or Bcc to insert the name in the eld. To select multiple

recipients, press Ctrl while making these selections.

Tip:  You can enter the rst few leers of the name in the eld at the top of the Select Names window.
The rst name in the list that matches the leers you entered is highlighted. Notice that this name may
be an individual’s name, an email address, or a group or distribution list.

4. Click OK.
5. Click Send to forward the record to the recipients you selected.

Check Names Window  
When forwarding records, if you enter a name, a partial name, or an email address that is not found in the knowledge
base, and then tab to the next eld or click Send, the Check Names window opens.

This window displays suggestions for sta accounts, sta account groups, distribution lists, and email addresses based
on what you entered in the To, Cc, or Bcc elds. From this window, you can double-click a list item to select a recipient or
click the Cancel buon to return to the previous window and re-enter the name.

Copy a Record  
Oracle Service Cloud lets you copy a record to use as a starting point for creating another record.
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Assume you have a contact record that is associated with an organization. When you add another contact from
the same organization, you might want to copy the original contact and edit the names to avoid having to re-enter
organization information.

1. Do one of the following:

◦ With a report open on the content pane, right-click the record you want to copy and select Copy. The
Copy window opens.

◦ With the record open, click Copy on the ribbon.

2. Select the option for each of the data items you want copied with the record.

Record Type Copy Options

Answer ◦ Access Level—Select from drop-down menu.

◦ Language

◦ Status—Select from drop-down menu.

◦ Copy File Aachments

◦ Copy Notes

◦ Create Sibling Relationship—Select this check box to create a sibling relationship
between the answer and the copy.

◦ Save and Close Copies—Select this check box to automatically save and close
copies of answers.

Asset No copy options are displayed when copying an asset record.

Contact ◦ Notes

◦ File Aachments

◦ Contact Lists

Incident ◦ Threads

◦ Incident Contacts

◦ File Aachments

When copying an incident, the original reference number is prepended to the incident
subject of the copied incident for identication purposes.
 
When copying an incident that is associated with a social channel, the thread type is
automatically set to Email.
 

Opportunity ◦ Notes

◦ Opportunity Contacts

◦ Opportunity Competitors

◦ File Aachments

◦ Quotes

◦ Quote Products

Organization ◦ Notes

◦ Organization Addresses
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Record Type Copy Options

◦ File Aachments

Task ◦ File Aachments

◦ Notes

3. Edit the copied record as necessary.
4. Click Save.

Print a Record  
When you want a hard copy of a record, you can print it from the open record or from a report that includes the record.

1. Do one of the following:

◦ Right-click the record on a report and select Print. The Print Dialog window opens.

◦ With the record open, click Print on the ribbon.

2. Click File and select Print.
The Print window opens.

3. Click Print.

Tip:  When you print incidents, contacts, tasks, opportunities, answers, organizations, assets, or
quotes, the format is dened by print pages in message templates. You can customize these templates
from the Message Templates editor. See Print Templates.

Close Multiple Records Simultaneously  
You can close multiple open records at the same time using the right-click menu.

1. Select the records you want to close.
2. Right-click an individual tab and select one of the following options.

◦ Open in New Window—Opens the active tab in a separate window.

◦ Close—Closes the active tab. You can also press Ctrl+W or Ctrl+F4 to close the active tab.

◦ Close All But This—Closes all open tabs except the active one.

◦ Close All—Closes all tabs.

Note:  Right-click options dier for workgroups. For example, when you right-click the tab of the
primary record in a workgroup, your only option is to close all associated records in the workgroup.
See Record Workgroups.

Audit Logs  
When you click the Audit Log tab on a record, you can see if other sta members have worked on the record.
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You can view each action taken on the record, when it was updated, who made the change, the action performed, and a
description of the action (for example, sending a response). This information is valuable for keeping track of interactions
with customers, especially if more than one sta member has worked on the same record. The audit log shows any
automatic changes that resulted from the application of business rules or through conguration seings. The audit
log for incidents and contacts also shows any actions taken by the customer on the customer portal. See Change the
Account Overview Page Headings.

In addition to records (answers, assets, contacts, incidents, opportunities, organizations, and tasks), Oracle Service
Cloud provides an audit log for campaigns, contact lists, documents, mailings, segments, surveys, and quotes.

Column Description

When Displays the time and date the action was performed on the record or other item. By default, the most
recent action is listed rst.

Who Displays the sta member who performed the action.
If Administrator is listed in this column, the action was the result of a business rule or an automatic
update by Oracle Service Cloud.
 

What Displays the type of action performed.

Description Displays a brief description of the action performed or provides additional information about the
action.

The Audit Log tab for quotes contains additional information. See How You Manage Quotes.

Tip:  You can click a column heading to sort the list by the column you select. Click the column heading again
to reverse the list.

Assign a Record from a Report  
There are several operations that are similar for dierent kinds of records. Among those operations are assigning sta
members and adding ags to records, checking the spelling, aaching les, including browsing and searching for les to
aach, and working with multiple records.

Sometimes you might need to assign a record to another sta member. For example, a task might have been incorrectly
assigned to you or you need a colleague to complete part of an incident before you can respond to a customer. Or
maybe you are creating contact and organization records and need to assign a salesperson to the account based on
their location. The sta member you assign the record to will receive a notication. See Notications.

1. Do one of the following:

◦ With a report displayed on the content pane and a record selected in the report, click Assign on the
ribbon. The Assign [Record] window opens to display a list of sta members who can be assigned the
record. (The list shows only those sta members who have permission in their prole to work on that
type of record.)

◦ Right-click the record in the report and select Assign or  Assign > [Type of record] .

2. Do one of the following:

◦ Select a sta member from the Recent list, if any appear. Up to ten of the most recent selections are
shown.
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◦ Use the auto-complete function to quickly nd a name in the list of sta members. Begin entering the
sta member or group name you want to assign the record to in the search eld above the list. As you
type, the list of names is ltered to show only names that contain the sequence of leers you entered,
and the focus is on the rst name on the ltered list. Enter additional leers of the name to narrow the list
further.

Note:  For hierarchical menus, matching names will have all of their ancestors shown in the list,
and they will be expanded. The children will also be in the list, but they are collapsed.To manually
search for a name in the list, click the right arrow next to a group or manager name to display the
names below it.

3. With the sta member you want to assign the record to highlighted, press the Enter key or click OK. When
you open the record, the sta member or group you selected will appear in the Assigned eld (for answers,
incidents, opportunities, and tasks) or the Salesperson eld (for contacts and organizations).

Assign an Open Record  
You can assign an open record to another sta member. The sta member you assign the record to will receive a
notication.

1. Click the Assigned eld drop-down menu. (For a contact or organization, click the Salesperson eld drop-
down menu.)

2. Do one of the following:

◦ Select a sta member from the Recent list, if any appear. Up to ten of the most recent selections are
shown.

◦ If you are assigning an open contact, incident, organization, or task, use the auto-complete function to
quickly nd a name in the list of sta members. Begin entering the sta member or group name you
want to assign the record to in the search eld above the list. As you type, the list of names is ltered to
show only names that contain the sequence of leers you entered, and the focus is on the rst name on
the ltered list. Enter additional leers of the name to narrow the list further.

Note:  For hierarchical menus, matching names will have all of their ancestors shown in the list, and
they will be expanded. The children will also be in the list, but they are collapsed.To manually search
for a name in the list, click the right arrow next to a group or manager name to display the names
below it.

3. If you are assigning an open answer or opportunity, begin entering the name of the sta member or group you
want to assign the record to in the Find eld below the list. As you type, the focus moves to the rst name on
the list that contains the sequence of leers you entered. Enter additional leers of the name to narrow the list
further.

◦ To nd a previous matching name, click the up arrow.

◦ To nd the next name that matches in the list, click the down arrow next to the Find eld.

Note:  List hierarchy is used in determining match precedence.

4. Do one of the following:

◦ With the sta member you want to assign the record to highlighted, press the Enter key to select it.

◦ Click a sta member or group name from the list to select it.

The menu closes and your selection appears in the eld.
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Add a Flag to a Record  
The standard workspace for answer, incident, opportunity, contact, and organization records includes a ag that lets
you dene the priority and enter a message regarding the record. When other sta members open the record, the ag
and text you added appear on the record.

1. Click the area next to the white ag at the top of the content pane. A menu displays options for selecting the
importance of the ag and editing text in the banner.

2. To change the importance of the ag from No Importance, select High (indicated by a red ag), Medium
(indicated by a blue ag), or Low (indicated by a green ag).

3. To add text to the ag, select Edit Flag Text and enter text in the eld.

Spell Checking  
Oracle Service Cloud uses three methods of spell checking.

The rst method of spell checking is an inline spell checker that automatically identies misspelled words on various
tabs and elds as you type. The second method is manual and checks any elds for which the spell check property has
been selected. The third method automatically checks your spelling when you save the record.

The spell checking methods in use depend on the selections your administrator used to congure the workspaces for
adding and editing records. On any workspace, it is possible that none of the elds have spell check enabled, that some
elds are spell checked automatically, or that elds are spell checked only when you click Spell Check on the ribbon.

Note:  If the language of an incident is dierent from the language of the interface from which the incident
response is created, the spell checker uses the dictionary that is associated with the language specied in the
incident’s Language eld. If this value is changed during an edit of the incident, the dictionary for the newly
selected language is used to check the spelling. In addition, if an incident is being edited on an interface that
supports spell checking, but the incident has a language that does not support spell checking, then Spell
Check is disabled.

Related Topics
• Create a Workspace

Correct an Inline Misspelling  
If your administrator has congured inline spell checking for elds in the workspaces you use, any text you enter in
those elds is checked in real time.

Oracle Service Cloud automatically corrects any misspelled words you have added to your dictionary as well as any
misspelling that has only one alternate spelling suggestion. The spell checker identies misspelled words by underlining
them with a wavy red line.

Note:  Words added during a spell check session are saved to your local dictionary. Future spell checking is
performed using the user dictionary on the server as well as the local dictionary on your workstation.
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Inline spell checking can occur when you enter information on the incident thread, on the Notes tab for contacts,
organizations, answers, opportunities, tasks, and in survey questions. When you move the cursor out of a eld that
contains a misspelling, the indicator for misspelling (the wavy red line) no longer appears. But it reappears when you
move the cursor back to the eld containing the misspelling.

Right-click the misspelled word and select one of the spell check options.

Option Description

Suggested alternate words Select one of the ve suggestions for alternate spellings. The misspelled word is replaced with the one
you selected.

AutoCorrect Select AutoCorrect and a suggested alternate word. Whenever Oracle Service Cloud encounters this
particular misspelling, it automatically replaces it with the word you selected.

Ignore All Select this option to ignore all occurrences of this spelling in the record you are editing.

Add to Dictionary Select this option to add the word to your personal dictionary. It will no longer be agged as
misspelled.

Check Spelling Manually  
Rather than correcting each misspelled word individually as you work, you may prefer to wait until you are done
entering all information for the record before you check the spelling.

Only the elds that are designated for spell checking are checked. Misspelled words in other elds will not be identied.
If no elds have spell check properties, a message will let you know there are no elds marked for spell check.
In order to check spelling manually, the workspace ribbon must contain Spell Check. Ribbons are dened when your
administrator creates workspaces, which are then assigned to your prole.

1. Click Spell Check.
The Spell Checker window opens, and the rst misspelled word is highlighted in the Not in Dictionary eld.

2. Select one of the spell checker options.

Option Description

Ignore Once Click this buon to ignore this occurrence of the misspelled word.

Ignore All Click this buon to ignore all occurrences of the misspelled word during your current
session.

Add to Dictionary Click this buon to add the word to your local dictionary.

Change Click this buon to replace this occurrence of the misspelling with the suggestion you
select from the options in the Suggestions eld.

Change All Click this buon to replace all occurrences of the misspelling with the suggestion you
select from the options in the Suggestions eld.

Suggest More Click this buon to nd additional suggested replacements for the misspelled word.

435



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Option Description

Options Click this buon to select the spelling options you want the spell checker to use when it
checks your spelling.

Undo Click this buon to undo the most recent change to a word. Additional buon clicks
undo one change at a time, in reverse order of the original changes.
Only the changes that have been made since the Spell Checker window was opened
can be undone.
 

Help Click this buon to open help information for the spell checker.

Cancel Click this buon to cancel the spell check.

3. Click OK.

Set Spell Check Options  
You can set specic options to streamline your spell check.

1. Click Spell Check.
The Spell Checker window opens.

2. Click Options.
The Spell Checker Options window opens.

3. Select any spelling options you want used during the spell check and clear any you do not want used.

Note:  You must select either Phonetic Suggestions or Typographical Suggestions (or both) in order for
the spell checker to return suggestions for misspelled words.

4. Select an option to specify speed and accuracy of the spell check.
5. Click OK.

Automatic Spell Checking  
Your administrator may have congured your workspace to automatically check spelling when you save a record.

If this applies to your workspace and no spelling errors are found, you will not see any evidence of the spell checking
process when you save the record. If the record contains misspellings, the Spell Checker window opens and you can
make corrections as described in Check Spelling Manually. If you click Cancel to stop checking the record’s spelling, a
message noties you and asks if you still want to save the record. Click Yes to cancel the spell checking and save the
record.

Note:  Your administrator may have disabled your ability to cancel an automatic spell check.
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Overview of the Aachments Tab  
Using the Aachments tab, you can aach les to records—answers, contacts, incidents, opportunities, organizations,
and tasks—as well as to campaigns, surveys, mailings, and documents.

The Aachments tab lets you add les containing information that may not t neatly into a record. For example, you
might want to aach a le that contains graphic elements to an incident. When one or more les are aached to a
record, the Aachments tab displays a paper clip icon.

The aachments report on the Aachments tab contains columns that provide the following information about each le
aachment: le name, le size, date and time the le was created, date and time the le was updated, description, le
visibility (Private column), and links for opening, downloading, and deleting the aachment.

The Private column appears only for incidents and answers and displays the visibility of the aachment on the customer
portal. See View Aachment Properties.

Tip:  You can drag le aachments located on your workstation and drop them onto any incident, answer,
opportunity, contact, organization, or task if the Aachments tab is active.

Buon Description

Add Files Click this buon and select Browse or Search to nd and aach a le.

Browse Select this option to view the les and folders on your workstation and select one or more to upload
and aach to the record. See Browse for a File to Aach to a Record.

Search Select this option to specify a directory, all or part of a le name, and type of le. The les that match
these criteria are displayed so you can select the ones you want to upload and aach to the record. See
Search for a File to Aach to a Record.

Open Click this buon to open the le for viewing.

Download Click this buon to download the le aachment and save the le to the location you specify on your
workstation.

Properties Click this buon to view or edit the properties of a le aachment. See View Aachment Properties.

Delete Click this buon to remove the selected le aachment from the record.

Answer File Aachments  
Files that are aached to answers are not the same as le aachment answers.

A le that is aached to an answer on the Aachments tab appears as an aachment within the answer on the Answers
page, and is used to provide additional information. A le aachment answer appears as a clickable aachment on the
Answers page, and displays the full answer content when clicked.

Sibling answer aachments with access levels that are at or below the contact’s SLA are visible to the contact. See
Sibling Answers.
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Incident File Aachments  
Files that are aached to incidents are not the same as les aached to incident responses.

When you aach a le to an incident, that le becomes permanently aached to the incident. Likewise, if a customer
aaches a le to an incident when submiing a question, that aachment also becomes permanently aached to the
incident. You and other sta members can access the les from the Aachments tab of the incident, while the customer
can access them from the Your Account page on the customer portal. In addition, some incident le aachments may be
accessed from the Messages tab. See Incident Aachments Tab.

Note:  HTML email updates that are larger than the maximum description size are aached to the incident as
an HTML le instead of as a text le.

Aaching a le to an email response lets the customer open the le directly from the email client instead of having
to log in to the customer portal to view it. All les aached to an incident or incident response are recorded in the
knowledge base and audit log. See Aach Files to an Incident Response.

Browse for a File to Aach to a Record  
When you want to aach a le to a record, you can locate the le by browsing or searching. The following procedures
describe each method.

You can aach an unlimited number of les to a record, but each le can be no larger than 20 MB by default. Contact
your administrator to learn if additional le size limitations exist on your system.

1. Click the Aachments tab.
2. Click Add Files and select Browse.

A window opens and displays the les and folders on your workstation.
3. Select the le to aach.
4. To aach additional les, press Ctrl while selecting the les.
5. Click Open to aach the le to the record.

Search for a File to Aach to a Record  
You can search for les you want to aach to a record.

1. Click the Aachments tab.
2. Click Add Files and select Search.

The File Search window opens.
3. Enter eld information.

Field Description

Search directory Enter the name of the directory where you want to search for the le, or click Browse.

Browse Click Browse to display the le structure and make a selection from the list of available
directories.

Part of le name or extension Enter all or part of the le name in this eld.
This eld uses an implicit wildcard at the end of the entry.
 

Filters To select a ltering option for narrowing the search, clear the All Files (*.*) check box,
 which is selected by default.
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Field Description

Documents (*.doc, *.xls, *.pdf, *.txt) Select this check box to search for document les.

Audio (*.mp3, *.wav, *.wma) Select this check box to search for audio les.

Images (*.jpg, *.bmp, *.gif) Select this check box to search for graphics les.

All Files (*.*) Select this check box if you do not want to restrict the search by le type.

4. Click Search to display a list of les that meet the search criteria.
5. Click a le to select it for uploading.
6. To aach additional les to the record, press Ctrl while selecting the les.
7. Click Add Files.

View Aachment Properties  
You can view properties for le aachments. You can also add le information and designate whether to index the le
for answer le aachments.

1. Select a le aachment from the list and click Properties on the Aachments tab toolbar.
2. Enter eld information.

Field Description

*File Name This eld displays the le name. You can change the name of the le.

Display Name Enter the name you want the le to display as on the customer portal.

Description Enter a description of the le to provide more information about it.

Private Select this check box to make the aachment private.
The Private check box appears only for les that are aached to answers and incidents.
Customers do not see private aachments on the customer portal.
 

Indexed Select this check box to index the le. Text contained in the aachment is searched
when customers perform a search on the customer portal.
The Indexed check box appears only for les that are aached to answers.
 

3. Click OK.

How You Update Multiple Records  
Multi-editing lets you update more than one record in a single operation instead of performing the same action on each
individual record.

This feature saves time when you need to make the same change to several records. For example, you might want to
add the same ag to several records.
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Note:  In addition to opening a multi-edit workspace that let you make the same change to multiple records
simultaneously, you can also open multiple records in a single operation by right-clicking the selected records,
selecting Open Separately, and selecting the type of record you want to open. Rather than opening a multi-
edit workspace, as described in Edit Multiple Records, this procedure opens each record separately. You can
then edit each record independently of the others.

The changes you can make to multiple records depend on the workspace dened by your administrator. This table
lists the elds you can edit for each record type when working on that record’s standard workspace. If you are working
on custom workspaces, the elds that are editable depend on the workspace your administrator congured and may
include more or fewer elds than those available on the standard workspace for that type of record.

Standard Multi-Edit Workspace Fields Available for Multi-Editing

Answer • Status

• Assigned

• Review On

• Publish On

• Notes

• Products/Categories

Asset • Organization

• Contact

• Product

• Status

• Date Purchased

• Date Installed

• Date Retired

• Price

• Description

Contact • Salesperson

• State

• Disabled Flag

Incident • Assigned

• Product

• Status

• Category

• Queue

• Disposition

• Messages tab

• S/MIME signing and encryption of responses are disabled when you edit multiple incidents
simultaneously.
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Standard Multi-Edit Workspace Fields Available for Multi-Editing

Note:  Answers cannot be added to incidents when using multi-editing. You must add an
answer to each individual incident record.

Opportunity • Organization

• Status

• Strategy

• Stage

• Manager Forecast

• Rep Forecast

• Forecast Close

• Assigned

• Date of Initial Contact

• Recall

• Date Closed

• Closed Value

• Summary

Organization • Salesperson

• State

Task • Assigned

• Due Date

• Planned Completion

• Date Completed

• Status

• Priority

• Percent Complete

• Task Type (Opportunity, Incident, Answer, Campaign, Mailing, Survey, Document)

Edit Multiple Records  
You can edit multiple records at the same time from the Oracle Service Cloud application.

1. Double-click a report to display a list of records.

You can specify unique criteria to search for all records you want to update. See Search for a Record from a
Report.

2. Press Ctrl while selecting each record you want to edit.
3. Click Open on the ribbon.

The elds that you can edit for the type of record you are working with display on the content pane.
4. Edit the records. Depending on the type of eld, you can accomplish this in one of several ways.

The drop-down menus for all elds default to No Change. To remove the prior eld entries for multiple records,
select the check box next to the eld you want to change.
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◦ To change a eld associated with a drop-down menu, click the drop-down menu and select an option.

Tip:  A shortcut is available for re-assigning multiple answers, contacts, incidents, opportunities,
organizations, or tasks. Select the records from a report, click Assign on the ribbon, and select a
sta member or group from the Assign window. See Assign a Record from a Report.

◦ To change a date eld, click the drop-down menu associated with the eld to open the current calendar
month and select a date. If necessary, use the arrows at the top to change the month before clicking a
day.

◦ To change a search eld, click Search (the magnifying glass to the right of the eld), enter the search
criteria in the window that opens, click Search, and select an option from the list of displayed results.

◦ To change a text eld (such as the Response eld on the Messages tab of the incident workspace), enter
the new entry for the eld.

Note:  If a eld is required when editing a record, it is also required for editing multiple records of the
same type. It is possible, however, to select a value of “No Value” as a valid entry on the multi-edit
workspace. The next time you edit one of the records separately, you are required to select a value for
the eld.

5. Click Save.

Delete Multiple Records  
You can delete multiple records at the same time from the Oracle Service Cloud application.

CAUTION:  Deleting records can aect other sta members within your organization. Deleting contacts, for
example, permanently removes not only the contacts from the knowledge base, but also all incidents and
opportunities for which the contact is the primary contact. Be sure you understand the consequences of
deleting records before you do so. See What Happens When You Delete a Contact.

1. Double-click a report to display a list of records.
2. Press Ctrl while selecting each record on the content pane you want to delete.
3. Click Delete on the report ribbon.
4. Click Yes on the Delete message to delete the selected records.

Forward Multiple Records  
You can forward multiple records at the same time from the Oracle Service Cloud application.

1. Double-click a report to display a list of records.
2. Press Ctrl while selecting each record on the content pane that you want to forward.
3. Click Forward on the report ribbon.
4. Follow the procedure for forwarding single records as described in Forward a Record.

Note:  All of the les aached to all of the incidents you selected appear in Incident Files. Select the
check box for every le aachment you want to forward with the associated incident. Recipients
receive individual emails for each incident you forward. If an incident has le aachments and you
selected the check boxes for those aachments, the forwarded incident contains the aachments.
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Record Workgroups  
Oracle Service Cloud helps you manage multiple open records without confusion by grouping all associated records into
a single workgroup.

Workgroups apply to incidents, answers, campaigns, contacts, contact lists, documents, mailings, opportunities,
organizations, surveys, and tasks. When you open any type of record and then open other records associated with the
initial record, you create a workgroup. The set of records in a workgroup can be saved and closed in a single operation.

For instance, the standard incident workspace lets you add or edit other information associated with the incident,
including contacts, organizations, and tasks. When you open a record associated with the open incident (for example,
opening the contact record by clicking the contact name and selecting Open), the record opens on a subtab below
the incident’s content pane tab and becomes the active tab. This creates a workgroup consisting of an incident and a
contact record.

Tip:  Typically, you will also have an incidents report open, which you will use to open each incident.

Each time you add or edit an additional record associated with the incident, it opens on another subtab and becomes
part of the workgroup. You can move easily between the records in the workgroup by clicking on the subtabs.

A record tab contains buons that correspond to the buons on the Editor group of the ribbon: OK, Cancel, and Undock.
All subtabs, except for the primary record (in this case, the incident), contain these buons for taking actions on the
individual record within the workgroup.

• OK—Clicking this buon accepts changes made to the record and closes the subtab. However, it does not save
changes to the database until you click Save or Save and Close on the ribbon.

• Cancel—Clicking this buon closes the subtab if you haven’t made changes to the record. If you have made
changes, a message asks if you want to discard your changes.

• Undock—Clicking this buon undocks the record from the editor and opens it in a new window. It remains in
the workgroup. You can move between working in the window and working with other records in the workgroup
without closing the window. (To redock the window to the editor, click Dock on the window.).

Continuing the example of the incident workgroup, clicking the incident subtab moves the focus to the incident in the
workgroup. Since the incident is the primary record in the workgroup, there are no buons on the subtab. The initial
content pane tab for the primary record shows the number of records in the workgroup in parentheses.

Expanded tooltips on Save and Save and Close buons on the ribbon and Quick Access toolbar let you know which
records will be saved by each action.

• Save—Clicking this buon saves all records in the workgroup and all editors remain open.

• Save and Close—Clicking this buon saves all records in the workgroup but closes all editors as well.

In addition, the save icon displays on each individual record in the workgroup when you hover over one of the
save buons, another visual indicator of which records will be saved. To create workgroups, see Create an Incident
Workgroup.

Create an Incident Workgroup  
The following procedure is an example of creating an incident workgroup.
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Keep in mind that you can open any record for the incident, not just the ones identied in this procedure. Also keep in
mind that the steps are the same for creating other types of workgroups.

1. Right-click an incident in an incidents report and select  Open > Incident .
The incident displays on the content pane.

2. Click the Contacts tab.
3. Right-click a contact and select Open.

The contact opens on a subtab.
4. To open additional records associated with the incident, repeat the previous two steps, replacing the references

to contact information with information about the type of record you are opening.

When you click Save on any record in the workgroup, all records in the workgroup are saved. Likewise, when
you click Save and Close on the ribbon, all records are saved and closed.

Note:  If you close any record in a workgroup without saving it, it does not impact your changes on any
of the workgroup’s other records.

Now, if you open a second incident, all the records associated with your rst incident remain open, grouped on
a single tab, with the number of records in the workgroup displayed in parentheses on the tab. Just as you did
with the rst workgroup, you can open as many records as necessary for the second incident to create another
workgroup. You can also open as many workgroups as necessary. A workgroup is active until you close it. If you
reopen the incident, only the incident is opened and not the associated records that were part of the workgroup
from the earlier editing session.

Record Information Available in Outlook Appointments  
This topic describes the record information that is transferred to Outlook appointments for each record type.

When you add and edit contacts, incidents, opportunities, organizations, and tasks, you can create an Outlook
appointment associated with the record you are working on. By default, the Appointment buon is available on the
standard workspaces for contacts, incidents, opportunities, and organizations and may be available on workspaces for
tasks if your administrator added it.

Depending on the type of record you are creating an appointment for, Oracle Service Cloud automatically adds record
information to the Outlook appointment, including the subject of the appointment.

Record Available Information

Contact • Name (subject of the appointment)

• Title

• Email

• Oce phone number

• Address (street address, city, and postal code)

• Banner text associated with the record ag

• Notes

Incident • Subject (subject of the appointment)

• Customer entry
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Record Available Information

• Response

• Banner text associated with the record ag

Opportunity • Opportunity name (subject of the appointment)

• Manager estimate (Manager Value)

• Sales rep estimate (Rep Forecast)

• Closed value

• Summary

• Notes

Organization • Organization name (subject of the appointment)

• Addresses (street, city, and postal code for each available address type)

• Banner text associated with the record ag

• Notes

Task • Task name (subject of the appointment)

• Due date

• Planned completion date

• Completed date

• Percentage complete

• Notes

Add an Outlook Appointment  
You can add an Outlook appointment for contact, incident, opportunity, organization, and task records.

1. Right-click the record that you want to create an appointment for and select Open followed by [Record Type].
The record opens on the content pane.

2. Click Appointment to open the Appointment window.
The available record information displays in the appointment.

3. To add or edit any of the appointment information, enter the information in the appropriate eld.
4. To add a color category to the appointment, click Categorize and select the category.

The rst time you assign a default color category to an appointment, you are prompted to rename the category.

Oracle Service Cloud automatically adds the category EM (Experience Management) to all new appointments.
The appointment category displays above the Subject eld.

5. To add multiple color categories to the appointment, click Categorize and select All Categories.
The Color Categories window opens. From this window you can quickly select multiple categories, rename and
delete categories, change category colors, and add shortcut keys.

6. Make your changes to the appointment’s categories and click OK.
7. Click Save.

It now appears in your Outlook calendar.
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Notications  
Your notications appear on the content pane when you double-click Notications from any navigation list that contains
the Notications component.

You also receive desktop alerts, often referred to as “toast,” when you rst log in to Oracle Service Cloud and when new
notications are received while you are logged in. Notications are triggered when:

• An answer, incident, opportunity, or task is assigned to you.

• An answer, incident, opportunity, or task that was assigned to you has been reassigned to another sta
member.

• An answer, incident, opportunity, or task has been escalated.

• An answer is scheduled for review.

• An incident is updated, closed, or reopened.

• A mailing is launched or completed.

• A system error has occurred.

• A broadcast notication is sent to you from another sta member.

Open Your Notications  
The Notications component lets you view and manage the notications you receive.

The following procedure assumes you open your notications from the Communication Center navigation list, which
is displayed when you click the Communication Center buon on the navigation pane. However, the navigation list in
which the Notications component appears depends on the navigation set assigned to your prole. You can open your
notications from any navigation list that contains Notications.

1. Click Communication Center on the navigation pane.
2. Double-click Notications.

The content pane displays your notications. From the list of your notications, you can send a message, delete
one or more notications, and refresh the display.

Buon Description

New Click this buon to open the Send Notication window, where you can enter a message
and select a recipient.
This buon is enabled only when your prole has permission to send notications.
 

Delete Click this buon to delete the selected notication.

Delete All Click this buon to delete all notications.

Refresh Click this buon to refresh the list of notications.

The list of your notications contains the following column headings.

◦ Type—Displays the icon that is associated with the notication type.

◦ Who—Displays who sent the notication.
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◦ Notication Type—Displays the type of notication.

◦ Message—Displays a summary of the notication.

◦ When—Displays the date and time the notication was sent.

Related Topics
• Send a Broadcast Notication

Desktop Alerts  
Notications display as desktop alerts, also known as toast notications, when you are logged in to Oracle Service
Cloud.

The desktop alert message is displayed in a window on the lower right section of the display for several seconds until it
fades away. These notications also appear in your list when you double-click Notications on the navigation pane, and
they remain in your list until you delete them.

If you have been sent a notication while you are logged in, the desktop alert appears when the Notications list is
automatically refreshed. The default refresh interval is fteen minutes, but your administrator may have changed that
interval. Alerts also appear if new notications are available when you manually refresh the list.

Tip:  If you do not want your system to display a desktop alert when you receive a notication, you can disable
alerts by clearing the Display Toast Notications check box from your personal seings. See Change Your
Personal Seings.

Send a Broadcast Notication  
If your prole gives you permission, you can also send broadcast notications from this component.

Your prole may give you permission to send notications to other sta members. If so, you can select the recipients
manually or send a notication to all logged-in sta members.

1. Double-click Notications on the navigation pane.
2. Click New to open the Send Notication window.
3. To send the notication to all sta members who are logged in, select the Send To All Logged In Users check

box.
When you select this check box, you cannot select individuals because To is grayed out.

4. To send to selected sta members, click To to open the Select Names window.
To import your contacts from the default Contacts folder in Outlook, select the Load Outlook Contacts check
box. This is useful for displaying contacts that are not included in Oracle Service Cloud.

a. Select one or more names from the list.
b. Click To to add the names to the eld.
c. Click OK to close the Select Names window. The names you selected appear in the To eld of the Send

Notication window.
5. Enter your message in the Message eld of the Send Notication window.
6. Click Send.
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Tip:  You can also enter the rst few leers of the name you want to send the notication to in the
To eld of the Send Notication window. If only one sta member’s name begins with those leers,
the eld is automatically populated when you move to the Message eld. If multiple sta members’
names begin with the same leers, you can select the one you want from the Check Names window
that opens when you move to the Message eld.

HTML and Text Editors  

How the HTML Editor Works  
When creating content for use in mailings, surveys, message templates, or answers, you can add HTML using an HTML
editor built into the system.

The HTML editor for answers is dierent from the HTML editor used for mailings, surveys, and message templates. The
information in this section pertains to the HTML editor for mailings, surveys, and message templates. For details about
the HTML editor for answers see HTML Editor for Answers.

The HTML editor contains many of the same options available in basic word processing applications and also has
specialized operations such as adding web forms, conditional sections, incident threads, merge elds, and merge reports.

You can create content in design or source mode. Using design mode, you can create dynamic, well-formaed content
even if you do not have previous HTML experience. You can include special formaing in your text and add graphics,
links, and other HTML features. You can also add links to existing content. See How You Add HTML in Design Mode.

Note:  For design mode to be available in Oracle RightNow Outreach Cloud Service (Outreach) and Oracle
RightNow Feedback Cloud Service (Feedback), the HTML Design Mode permission must be selected for both
Outreach and Feedback in your prole. See Outreach Permissions and Feedback Permissions.

Using source mode, you can create content using HTML source code. Regardless of which mode you use to create
content, you can preview how it appears to customers from the Preview tab.

The links and dynamic content elements that display on the HTML editor are context-sensitive and depend on what
type of content you are creating.

Related Topics
• Links and Dynamic Content Elements

• Add HTML in Source Mode

• Preview Content

How You Add HTML in Design Mode  
Oracle Service Cloud contains an HTML editor for creating dynamic content.

When in design mode, you can use word processing functions to create HTML, as well as dynamic content, such as
adding a conditional section or a merge eld. You can add several types of links to your content as this image shows.
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The links and dynamic content elements that display on the HTML editor are context-sensitive and depend on what
type of content you are creating.

Note:  For design mode to be available in Oracle RightNow Outreach Cloud Service (Outreach) and Oracle
RightNow Feedback Cloud Service (Feedback), the HTML Design Mode permission must be selected for both
Outreach and Feedback in your prole. Otherwise, only source mode is available. See Add HTML in Source
Mode, Outreach Permissions, and Feedback Permissions.

Links appear as clickable text when the document is used in a message, mailing, or survey or as a web page. When a
link is added, you have the option of dening certain aributes depending on the type of link. Links, as well as forms
and dynamic content elements, are located in the toolbox.

Tip:  You can dene style and class properties on most toolbox and tasks elements (or options) by right-
clicking the element after you add it to the canvas. Keep in mind that style and class must be dened in a
CSS le that is available on your web server and linked to in the <head> tag of a message, mailing, or survey
template. See Edit Style and Class.

Using the toolbar, you can create HTML using many of the same options available in basic word processing applications.
Functions include:

• Cut, copy, and paste

• Find and replace text

• Print the document

• Undo and redo changes

• Switch to full screen

• Format text in numbered or bulleted lists

• Adjust indentation

• Center, left-justify, or right-justify text and images on the page

• Insert line breaks

• Change font size and style aributes (such as bold, italic, and underline)

• Apply special text formaing (such as color, highlighting, superscripts, and subscripts)
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• Copy text formaing using the style applier

Additional functions are accessed through the Toolbox and Tasks sections. Within the Toolbox, there are HTML, Links,
and Dynamic Content sections. When creating documents in Outreach and Feedback, there is also a Forms section.
Within the Tasks, there are Start Over and Content sections. For detailed information about these functions, see the
Toolbox Section and Tasks Section tables here: Links and Dynamic Content Elements.

Tip:  You can insert HTML by clicking a buon in the Toolbox or Tasks section, or by dragging and dropping
the buon to a specic location on the canvas.

Links and Dynamic Content Elements  
You can add several types of links and dynamic content elements to your content. When an element is added, you have
the option of dening certain aributes depending on the type of element.

Links appear as clickable text when the content is used in a message, mailing, or survey. The tools that display on the
HTML editor are context sensitive and are the logical tools you would use for the specic content you are creating.

Links and dynamic content elements are found in the Toolbox and Tasks sections of the HTML editor. Within the
Toolbox, there are HTML, Links, and Dynamic Content sections. In Outreach and Feedback, there is also a Forms
section. Within the Tasks, there are Start Over and Content options.

Tip:  You can insert HTML by clicking a buon in the Toolbox or Tasks section, or by dragging and dropping
the buon to a specic location on the canvas.

Buon Description

HTML Buons in this section are used to insert standard HTML elements in your content.

Hyperlink
 

Click this buon to insert a hyperlink. See Insert a Hyperlink.
 

Image
 

Click this buon to insert an image. See Insert an Image.
 

Horizontal Rule
 

Click this buon to insert a horizontal line.
 

Table
 

Click this buon to insert a table. See Insert a Table.
 

Div
 

Click this buon to insert a DIV block, which you can use to group other elements, such as buons.
 

Field Set
 

Click this buon to insert a eld set.
 

Buon
 

Click this buon to insert a buon. Double-click the buon on the canvas to edit the buon text.
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Buon Description

Links Buons in this section are used to insert links in your content.

Note:  Some buons apply only to message templates and are noted as such.

Account Assistance Link
 

Click this buon to insert a link to the Account Assistance page on your customer portal. See Insert an
Account Assistance Link.
 

Agent Browser UI Incident Link
 

Inserts a link to the incident that triggered the sent message so that agents can access the incident
from the Agent Browser User Interface. See Insert an Agent Browser UI Incident Link.
 

Answer Link
 

Click this buon to insert a link to any answer you specify. See Insert an Answer Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Browser Link
 

Click this buon to insert a browser link. See Insert a Browser Link.
 

Chat Link
 

Click this buon to insert a link to the Live Help page on the customer portal. See Insert a Chat Link.
 
This buon is available only if Oracle RightNow Chat Cloud Service (Chat) is enabled.
 

Cloud Link
 

Click this buon to insert a link to a social media service. See Insert a Cloud Link.
 

Customer Portal Incident Link
 

Click this buon to insert a link to the incident that triggered the sent message. For example, the
standard Question Receipt email sends a conrmation message after a customer submits a question
through the Ask a Question page, an email, or a chat session. By adding a Customer Portal Incident
Link to your Question Receipt message template, you can provide your customers with easy access to
the incident created from their question. See Insert a Customer Portal Incident Link.
 

File Link
 

Click this buon to insert a le link. See Insert a File Link.
 

Forward to Friend Link
 

Click this buon to insert a forward to friend link. See Insert a Forward to Friend Link.
 

Incident Link
 

Click this buon to insert a link to any incident you specify. See Insert an Incident Link.
 

Prole Link
 

Click this buon to insert a link to the Account Seings page on your customer portal. See Insert a
Prole Link.
 

Proof Comments Link
 

Click this buon to add more than one comment eld to the Survey Proof message template that is
sent to proofreaders of website link surveys. See Insert a Proof Comments Link.
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Buon Description

 
This buon is available only in message templates. See How You Customize Messages.
 

Proof Survey Link
 

This buon is included, by default, on the Survey Proof message template and links to the website link
survey you want your proofreaders to review. See Insert a Proof Survey Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Reset Password
 

Click this buon to insert a reset password link. See Insert a Reset Password Link.
 

Setup Password
 

Click this buon to insert a link to the Finish Account Creation page on your customer portal. See Insert
a Setup Password Link.
 

Survey Link
 

Click this buon to insert a link to a survey. See Insert a Survey Link.
 

Survey Results Link
 

This buon is included, by default, on the Survey Notication message template and links to a web
page that shows the survey responses. See Insert a Survey Results Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

This Answer Link
 

Click this buon to insert a link to the incident that triggered the sent message. See Insert a This
Answer Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

This Discussion Link
 

Click this buon to insert a link to the email discussion that triggered the sent message. See Insert a
This Discussion Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Tracked Link
 

Click this buon to insert a tracked link. See Insert a Tracked Link.
 

Unsubscribe All Answers Link
 

Click this buon to insert a link that lets contacts who receive answer notications unsubscribe from
future communications. See Insert an Unsubscribe All Answers Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Unsubscribe Link
 

Click this buon to insert an unsubscribe link. See Insert an Unsubscribe Link.
 

Unsubscribe This Answer Link
 

Click this buon to insert an unsubscribe link to a specic answer that’s been returned as the result of a
repeatable answer section. See Insert an Unsubscribe This Answer Link.

452



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Buon Description

 
This buon is available only on the Answer Update Notication message template. See How You
Customize Messages.
 

View Subscriptions Link
 

Click this buon to insert a link customers can use to edit the list of social notications they are
subscribed to. See Insert a View Subscriptions Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Web Page Link
 

Click this buon to insert a web page link. See Insert a Web Page Link.
 

Forms Buons in this section are used to insert web forms and survey questions in your HTML. These buons
are available only for documents, templates, and snippets created in Outreach and Feedback. See
Insert a Web Form.

Web Form
 

Click this buon to insert a web form to collect customer data. Documents can contain only one web
form.
 

Form Field
 

Click this buon to insert a database eld in the web form. Your web form must contain at least one
form eld.
 

Survey Question
 

Click this buon to insert a survey question in the web form.
 

Submit Buon
 

Click this buon to insert a buon for submiing the web form.
 

Dynamic Content Buons in this section are used to insert dynamic content in your HTML.

Answer Section
 

Click this buon to add any repeatable answer details on your answer update notication messages.
See Insert an Answer Section.
 
This buon is available only in message templates. See How You Customize Messages.
 

Case Section
 

Click this buon to add a case section to your conditional text. See Insert a Case Section.
 

Conditional Section
 

Click this buon to insert a section of conditional text. See Insert a Conditional Section.
 

Content Placeholder
 

Click this buon to add a content placeholder to your template. When you create a template by
uploading an HTML le, you must add a content placeholder because templates cannot be saved
without a content placeholder. See Create a Template.
 
This buon is available only for templates. For message templates, this buon displays in the HTML
section of the toolbox.
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Buon Description

 

Incident Thread
 

Click this buon to insert an incident thread that displays all communication between the parties
associated with the message. See Insert an Incident Thread.
 

Merge Field
 

Click this buon to insert a merge eld. See Insert a Text Merge Field.
 

Merge Report
 

Click this buon to insert a merge report. See How Merge Reports Work.
 

Buon Description

Start Over Buons in this section are used to clear all HTML content and start over.

Use Existing
 

Click this buon to clear all HTML elements and start over with an existing document.
 

Upload HTML
 

Click this buon to clear all HTML elements and start over with content uploaded from an HTML le.
 

Content Buons in this section are used to insert snippets and symbols and manage HTML anchors.

Apply Template
 

Click this buon to select a template to apply to a document. You cannot apply a template to templates
or snippets. See Create a Template.
 
After a template has been applied to a document, it can be cleared by clicking the Apply Template
buon, then clicking the Clear Template buon on the Choose Template window.
 

Insert Snippet
 

Click this buon to insert a snippet. See Create a Snippet.
 

Insert Symbol
 

Click this buon to insert a special symbol. A symbol map opens. Double-click the symbol you want to
insert.
 

Insert Address
 

Click this buon to insert a physical address. See Insert a Physical Address.
 

Note:  The CAN-SPAM Act of 2003 requires that commercial email messages contain the
sender’s valid physical postal address.

Manage Anchors
 

Click this buon to add or remove an anchor or go to an anchored site. See Insert an Anchor.
 

Test CAN-SPAM
 

Click this buon to test the document for CAN-SPAM compliance. See CAN-SPAM Compliance.
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Buon Description

This buon is available only when editing a document in a mailing message or survey invitation
message.
 

Modify Page Properties  
You can modify the HTML properties of your content to change colors of the text and links, insert a background image
or color, and change the title.

1. Right-click in the document and select Page Properties.
The Modify Page Properties window opens.

2. Enter eld information.

Field Description

General Information Dene the general information of the web page in this section.

Title
 

Enter the title of the web page.
 

Author
 

Enter the name of the web page author.
 

Description
 

Enter a description for the web page.
 

Text Colors Dene the colors used for text and links in this section.

Browser’s default seings
 

Select this option to use the web browser default color seings.
 

Use custom colors
 

Select this option and click the color boxes to dene the colors used for plain text, links,
 active links, and visited links.
 

Page Background Dene the background image or color.

Background image
 

Enter a URL to an image to use as the background in this text box.
 

Open URL
 

Click this icon to open the URL in a web browser.
 

Background color
 

Click this color box to choose a color to use as the background or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

3. Click OK.
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Edit Style and Class  
You can dene style and class aributes for most toolbox and tasks elements by right-clicking the element after you add
it to the canvas.

Keep in mind that style and class must be dened in a CSS le that is available on your web server and linked to with the
<head> tag of a template.

1. Right-click an element after you add it to the canvas.
2. Select Edit Style for <element type> element.
3. Enter eld information.

Field Description

Class
 

Enter any class name you want to assign to the element in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS for content included in mailings or
surveys.

Style
 

Enter any style aributes you want to assign to the element in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

4. Click OK to apply the aributes.

Insert an Account Assistance Link  
Account assistance links let you link to the Account Assistance page on your customer portal. From this page, your
recipients can get help if they do not have or have forgoen their user name or password.

1. Click Account Assistance in the Links section of the Toolbox.
The Account Assistance window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.
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Field Description

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Insert an Agent Browser UI Incident Link  
Inserting an Agent Browser UI Incident Link lets you link to the incident that triggered the sent message so that agents
can access the incident from the Agent Browser User Interface.

The Agent Browser UI Incident Link is included, by default, on any incident-related administrator notication and
administrator email message template. See How You Customize Messages.

1. Click Agent Browser UI Incident Link in the Links section of the Toolbox.
The Agent Browser UI Incident Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates
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Insert an Anchor  
From the HTML editor, you can add and remove anchors. Anchors are placed at designated locations within your
content as destinations for hyperlinks.

When you place an anchor in your content, it is invisible when you are in design mode. The anchor code, sometimes
referred to as a bookmark, displays only in source mode.

1. Click Manage Anchors from the Tasks section.
The Manage Anchors window opens.

2. Enter the anchor name in the Anchor Name eld.
3. Click Add Anchor to add the anchor at the insertion point.
4. To delete an anchor, select it and click Delete.
5. To rename an anchor, select it, click Rename, and enter a new name for the anchor.
6. Click OK.
7. Click Close.

Insert an Answer Section  
You can use an answer section to display repeatable answer details on your answer update notication messages
when more than one answer is sent in the same email. Any content that you include inside the answer section will be
repeated. Content outside of the answer section will not be repeated.

Let’s say you want your message to include the contact’s name and you want to show the answer ID for each answer.
In this case, you would insert the Answer ID merge eld inside your answer section and the Contact Name merge eld
outside of the answer section. By inserting Answer ID inside the answer section, this merge eld will repeat when more
than one answer is sent. Since Contact Name is outside of the answer section, it will not repeat.

This image shows an answer section which is included, by default, on the Answer Update Notication and Answer
Update Notication Expired message templates. You can customize both of these templates in message templates. See
How You Customize Messages.

1. Click Answer Section in the Dynamic Content section of the Toolbox.
An answer section is inserted into your template.

2. Insert the cursor inside the answer section and click Merge Field to add any elds you want to repeat when
more than one answer is sent in the email.

Note:  Keep in mind that any content outside of the answer section will not be repeated when more
than one answer is sent in the same notication email. Therefore, if you have content you do not want
repeated, add those merge elds outside of the answer section.

Related Topics
• Overview of Message Templates
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Insert an Answer Link  
There are two ways you can link to answers from Oracle Service Cloud. Inserting an Answer Link lets you link to any
answer you need to reference in the message sent to your customer. Inserting a This Answer Link lets you link to the
answer that triggered the sent message.

Both the Answer Link and This Answer Link are included, by default, on any answer-related message template. See How
You Customize Messages.

1. Click Answer Link in the Links section of the Toolbox.
The Answer Link window opens.

2. Enter eld information.

Field Description

Answer ID
 

Enter the answer ID for the answer you want to link to in this eld.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates

• Insert a This Answer Link

Insert a Browser Link  
Browser links let you add a hyperlink to an email message that opens a browser-based version of the same content. This
is useful for messages to contacts whose email clients disable image rendering by default.

1. Click Browser Link in the Links section of the Toolbox.
The Browser Link window opens.

2. Enter eld information.
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Field Description

*Text
 

Enter the text you want to appear as the hyperlink text.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS for content included in mailings.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Insert a Case Section  
Case sections help you make your content more relevant to your target audience than it would be by using independent
conditional sections.

You can specify a logical group of conditions where one, and only one, condition displays to your customer. In a case
section, as soon as the rst condition is matched, the content for that condition is added and any other conditions are
ignored. If no condition within a case section is matched, the content in the default section displays (as long as you have
dened it).

For example, you could create a case section that displays information to customers based on their location. The rst
condition within the case section might be specic to postal codes. If none match, the next condition could be more
general, such as states. If neither match, then the default section (if present) displays.

You can add as many conditional sections to your case section as you need to make your content relevant. See When to
Use Case Sections vs. Conditional Sections.

Tip:  Case sections and conditional sections can also be helpful when designing surveys for use on mobile
devices. See How You Customize Surveys for Use on Mobile Devices.

1. Click Case Section in the Dynamic Content section of the Toolbox.
A case section opens on the content pane.

2. Do one of the following:

◦ Double-click Conditional Section inside the Case Section.

◦ Right-click and select Add Conditional Section. See Insert a Conditional Section.
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You can apply style and class aributes by right-clicking an element after you add it to the canvas. See Edit Style
and Class.

3. If you want to add another conditional section to your case section, repeat step 2.
4. If you want to add content to the Default section, enter it in the eld below the default section header.

Tip:  If you add a conditional section after the default section, it will not be evaluated. Therefore, we
recommend that you do not add anything after the default section.

Insert a Chat Link  
If you have Chat enabled, you can insert a link to the Live Help page for your customers to chat with an agent. For
information about enabling Chat, contact your Oracle account manager.

1. Click Chat Link in the Links section of the Toolbox.
The Chat Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

How Cloud Links Work  
Cloud links let your contacts track or post your communications on several leading social media sites. You can include
cloud links in documents, templates, snippets, mailings, campaigns, surveys, and survey invitation messages.

When a contact clicks a cloud link, the specied service opens in a web browser and prompts the contact for
conrmation. The action taken upon conrmation depends on the service being used and the type of link you provided.
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Note:  Most social media services use cookies to identify contacts and automatically log them in to private
accounts. As a result, a cloud link’s transition to the conrmation page is often seamless. However, if a contact
has not created or logged in to an account before clicking a cloud link, the service usually prompts the contact
to do so before forwarding for conrmation.

When you create a cloud link, you can select from several leading services and link types. You may also be required to
enter the key that is used to identify your organization on the service you have selected.

Link Type Description/Key

Facebook (Share on Prole)
 

Clicking this link lets contacts share your communication as a message to their Facebook friends, or
post a link to a web browser version of your message on their Facebook prole. No key is required.
 

Facebook (Find Us)
 

Clicking this link takes contacts to your Facebook group page, where they can join your Facebook
group. When this option is selected, you must type your Facebook group ID in the Key eld. For
example, if your Facebook group URL is hp://facebook.com/group.php?gid=0123456789, the key
would be “0123456789.”
 

Flickr
 

Clicking this link takes contacts to your Flickr group page, where they can join your Flickr group. When
this option is selected, you must type your Flickr group ID in the Key eld. For example, if your Flickr
group URL is hp://ickr.com/groups/companyname, the key would be “companyname.”
 

Twier (Tweet)
 

Clicking this link lets contacts post a link to a web browser version of your message on their Twier
account. No key is required.
 

Twier (Follow)
 

Clicking this link takes contacts to your Twier page, where they can follow your organization with their
Twier account. When this option is selected, you must type your Twier group ID in the Key eld. For
example, if your Twier URL is hp://twier.com/companyname, the key would be “companyname.”
 

YouTube
 

Clicking this link takes contacts to your YouTube channel page, where they can join your YouTube
channel. When this option is selected, you must type your YouTube group ID in the Key eld. For
example, if your YouTube group URL is hp://youtube.com/companyname, the key would be
“companyname.”
 

LinkedIn
 

Clicking this link takes contacts to your LinkedIn group page, where they can join your LinkedIn group.
When this option is selected, you must type your LinkedIn group ID in the Key eld. For example, if
your LinkedIn group URL is hp://linkedin.com/groupRegistration.php?gid=012345, the key would be
“012345.”
 

MySpace (Share on Prole)
 

Clicking this link lets contacts post a link to a web browser version of your message on their MySpace
prole. When this option is selected, you must enter a title for your posted link in the Key eld.
 

Community
 

Clicking this link takes contacts to your Community Self Service page. No key is required.
 

Insert a Cloud Link  
Use cloud links to let your contacts track or post communications on social media. You can include cloud links in
documents, templates, snippets, mailings, campaigns, surveys, and survey invitation messages.

1. From the HTML or Text tab on the HTML editor, click Cloud Link in the Links section of the Toolbox.
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The Cloud Link window opens.
2. Enter eld information.

Field Description

Link Type
 

Click this drop-down menu to select the type of cloud link you want to insert. You can
select from the following options.
 
Facebook (Share on Prole)
 
Facebook (Find Us)
 
Flickr
 
Twier (Tweet)
 
Twier (Follow)
 
YouTube
 
LinkedIn
 
MySpace (Share on Prole)
 
Community
 

*Key
 

Enter the unique key value associated with the selected link type.
 
This eld is inactive when the link type is Facebook (Share on Prole), Twier (Tweet), or
Community.
 

Information (i)
 

Hover over this icon for information about the key required for the selected link type.
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 
This eld displays only when inserting cloud links in the HTML editor.
 

*Link Text
 

Enter the text you want to appear as the link in this eld.
 
This eld displays only when inserting cloud links in the Text editor.
 

3. Click OK.

Note:  The social media services described in this procedure, with the exception of Community Self
Service, are not provided by or aliated with Oracle. To obtain support or information about terms and
conditions for the services mentioned, contact the service provider.
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Insert a Conditional Section  
You can add conditional content that displays only when specic criteria is met. For example, you could add a
conditional section to a document used in a mailing for a segment of customers who live in a specic postal code.

In the system-generated message templates (administrator notications, administrator emails, and contact emails), you
can insert conditional sections that display content based on contact, prole, runtime variable, or record type. These
options are also available in mailings and surveys when you insert a conditional section within an incident thread. For
example, in certain message templates or if you’ve added a conditional section within an incident thread in a mailing or
survey, you can dene the conditional section to display a coupon based on the product specied in the incident. See
Edit a Message and Inserting incident threads.

Note:  The available options are context-sensitive and depend on what type of content you are customizing.

If you add more than one conditional section, each condition evaluates separately and if more than one condition
matches, content is shown for each matched condition. If you want to display content from only one condition, consider
using a case section instead of independent conditional sections. See Insert a Case Section.

For more information on how to use surveys on mobile devices, see How You Customize Surveys for Use on Mobile
Devices.

1. Click Conditional Section in the Dynamic Content section of the Toolbox.
The Conditional Section window opens.

2. Enter a title for the conditional section in the Title eld.
3. Select an option from the drop-down menu to include content based on whether the contact is included or not

included in the selected segment.
4. For mailings and surveys, select a segment from the Segments menu.

Segments are created when you dene audiences.
a. To create a segment, click New Segment. See Create a Segment.

5. For message templates or conditional sections inserted within incident threads in mailings and surveys, select
the Associated Contact, Recipient Prole, Runtime Variable, or Associated Record option. These options are
context-sensitive based on the type of content you are customizing.

a. To display text based on contact, see step 4.
b. To display text based on recipient prole, select an option from the drop-down menu to include content

based on whether the recipient is in or not in the selected prole, and then select a prole.
c. To display text based on runtime variable, select Include Contact Information Section. This option is

available only in the Email Incident Information (administrator email) message template. It lets the agent
decide whether contact information will be sent in the email. See Edit a Message.

d. To display text based on a record type, select an option from the drop-down menu to include content
based on whether the condition is true or false, and then select a record. Next, select an operator to use
in comparing the record to the data value, and then type a value that the record is compared to. See
Selecting lter operators.

6. Click OK to insert the conditional section.

Tip:  You can apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class. For message templates or conditional sections inserted within
incident threads in mailings and surveys, style and class aributes are applied on the incident type
thread properties. See Insert an Incident Thread.

7. Enter the content you want to display to your audience in the text box below the conditional section header.
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Note:  Due to the volume of conditional sections that accumulate as new content is created,
the Agedatabase utility regularly purges the database of orphaned conditional sections
(those that have been dened but not used in any campaign, document, or mailing). The
PURGE_COND_SECTION_DAYS conguration seing species the number of days after which an
orphaned conditional section is purged from the database. The default value is 7 days. Set to 0 to turn
o conditional section purging.

Related Topics
• Overview of Message Templates

Insert a Customer Portal Incident Link  
There are two ways to link to incidents from Oracle Service Cloud. Inserting a Customer Portal Incident Link lets you
link to the incident that triggered the sent message. Inserting an Incident Link lets you link to any incident you need to
reference in the message sent to your customer.

For instance, the standard Question Receipt email sends a conrmation message after a customer submits a question
through the Ask a Question page, an email, or a chat session. By adding a Customer Portal Incident Link to your
Question Receipt message template, you can provide your customers with easy access to the incident created from their
question. See How You Customize Messages.

1. Click Customer Portal Incident Link in the Links section of the Toolbox.
The Customer Portal Incident Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.
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Related Topics
• Overview of Message Templates

• Insert an Incident Link

Insert a File Link  
After les have been added, you can place them in your HTML content as links.

1. Click File Link in the Links section of the Toolbox.
The File Aachment window opens.

2. Enter eld information.

Field/Option Description

*Files
 

Select a le from this list. See Add a File.
 

New File
 

Click this text to add a le. The le is selected in the menu after being added.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Tip:  You can also apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Insert a Forward to Friend Link  
Forward to friend links let your customers forward your mailing or survey to additional email addresses. Recipients of
the forwarded message receive a copy of the mailing or survey, but are not added to your contact list.
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When contacts click the link, a page opens asking them for the email addresses of the friends they want to forward the
mailing or survey to.

Note:  The Subject eld of the Send To A Friend form contains the subject from the forwarded message
and cannot be edited. Contacts sending to multiple recipients must separate email addresses with a comma
or semicolon. Also, recipients of messages sent through the Forward to Friend link see the message, “This
message was sent to you by <email_address>,” regardless of whether the sender includes comments when
forwarding the message.

1. Click Forward to Friend Link in the Links section of the Toolbox.
The Forward to Friend Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML document by either using the <style> tag to dene the class inline,
 or posting the class in a CSS le on your web server and referencing it with the <link>
tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Insert a Hyperlink  
You can insert hyperlinks in your HTML content and then dene the hyperlink properties. You can also choose whether
to link to an external site or an anchor in this or another document.

1. Click  Hyperlink in the HTML section of the Toolbox.
The Hyperlink window opens.

2. Enter eld information.

Field Description

External Link Select this option to insert a link to a website outside of Oracle Service Cloud.
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Field Description

*Link
 

Enter the full URL of the hyperlink in this eld.
 

Open Hyperlink
 

Click this icon to open the hyperlink in a web browser.
 

Link Text
 

Enter the text you want to appear as the link in this eld.
 

Target
 

Select a target from this drop-down menu:
 

◦ New Window—The URL opens in a new browser.

◦ Same Window—The URL opens in the same frame.

◦ Parent Window—The URL opens in the same frameset.

◦ Browser Window—The URL opens in the same window.

Internal Link Select this option to insert a link to an internal anchor.
This option is available only if an anchor has been added to the document. See Insert an
Anchor.
 

Anchor
 

Click this drop-down menu to select an anchor to link to.
 

Link Text
 

Enter the text you want to appear as the link in this eld.
 

Email Select this option to insert a link to an email address.

*Address
 

Enter the email address in this eld. For example, enter lucybauer@example.com to
create a link to Lucy Bauer’s email address.
 

Note:  You do not need to prepend the email address with the “mailto:” tag.
The system adds the “mailto:” tag when you enter the email address in the
eld.

Link Text
 

Enter the text you want to appear in this eld.
 

3. Click OK.

Tip:  You can also apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.
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Insert an Image  
You can insert an image that is accessible through a URL in your HTML. You can also dene the size of the image, its
border properties, and alignment.

1. Click Image in the HTML section of the Toolbox.
The Image Editor window opens.

2. Enter eld information.

Field Description

*Image URL Enter the URL where the image is located.

Open URL
 

Click this icon to open the URL in a web browser.

Alt Text Enter the alternative text for the image.

Width Enter the width, in pixels, you want the image to appear as.

Height Enter the height, in pixels, you want the image to appear as.

Border Enter the width, in pixels, of the image border.

Alignment Click this drop-down menu to select the image alignment: Inline, Left, Middle, Right,
Top, or Boom. The default alignment is Inline.

3. Click OK.

How Incident Threads Work  
You can add an incident thread to your HTML so that all communication regarding an incident displays in your content.
The incident thread lists all activity about an incident, including the original question, responses and updates from
agents, customer updates, records of conversations, and internal notes about the incident.

You can dene thread properties, which apply to the entire thread entry, as well as dynamic thread content, which lets
you dynamically add content for a specic thread type. From the thread properties, you can customize the look of your
incident thread by dening style and class aributes, display order, and limits on the number of threads (up to 99) that
display in your messages. You can also set character limits on your incident threads to truncate the text that displays in
the email message.

In addition to dening style and display aributes for the entire thread, you can dene where to include your dynamic
content—either before or after the thread entry for each specic thread type. Choose whether your content displays
only in the most recent entry, in all entries, or in all entries except the most recent one. In the sample shown here, the
response thread type oers customers a coupon before the thread entry and only in the most recent response thread.

This image shows the Response Thread Type incident thread. This particular thread type is designed to display a
coupon above (before) the thread entry content and to be included only in the most recent entry.
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Note:  While dynamic content added from thread type windows is included in the email that is eventually sent,
it is not stored in the database. Therefore, it cannot be retrieved later.

Insert an Incident Thread  
Use incident threads to display all communication related to an incident in your HTML content.

1. Click Incident Thread in the Dynamic Content section of the Toolbox.
An incident thread opens on the content pane.

2. To edit the thread properties, double-click the incident thread.
The Thread Properties window opens.
Thread properties display by incident thread type. In Outreach and Feedback, all thread types, except for the
Private Note thread type, are selected by default. In message templates, whether or not the Private Note check
box is selected by default depends on the message type. For example, message templates that are designed
for agents will have the Private Note check box selected by default. However, on message templates that are
designed for customers, the check box will be cleared.

3. To dene the types of threads that display in your content, clear or select the check boxes in the Thread Type
section.

Note:  Because thread types are specic to the type of thread, you may need to edit several (or all)
thread types depending on which Oracle Service Cloud products your organization uses.

Thread Type Description

Customer Entry
 

Select this check box to display threads submied by the customer.
 
This option maps to both the Customer and Voice Integration incident thread type IDs in
the threads.entry_type eld.
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Thread Type Description

Response
 

Select this check box to display threads for incident responses submied from the
Response option on the incident workspace.
 
This option maps to the Response incident thread type ID in the threads.entry_type
eld.
 

Customer Proxy
 

Select this check box to display threads for incidents submied by an agent on behalf of
the customer from the incident workspace.
 
This option maps to the customer proxy incident thread type ID in the threads.entry_
type eld.
 

Chat Transcript
 

Select this check box to display incident threads created from a chat session.
 
This option maps to the Chat Transcript incident thread type ID in the threads.entry_
type eld.
 

Auto Response
 

Select this check box to display responses that are automatically added to the thread
from a business rule.
 
This option maps to the Auto Response incident thread type ID in the threads.entry_
type eld.
 

Private Note
 

Select this check box to display threads added as private notes on the incident
workspace or threads added through business rules to the Notes thread.
 
This option maps to both the Note and Rule Response Template incident thread type IDs
in the threads.entry_type eld.
 

4. To apply formaing styles for your thread content and headings, click the link on the Thread Properties
window that is specic to the type of thread you want to edit. For example, clicking the Response link opens the
Response Thread Type window.

5. Enter eld information.

Field/Option Description

Thread Properties Enter information in this section to dene how the content and heading of your incident
thread will display.
Thread properties apply to the entire thread entry. Thread properties are not available
when using the text editor. See Create Text Content in Documents.
 

Content Style
 

Enter any HTML style and class aributes you want the content of your entire incident
thread to display.
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Field/Option Description

By default, font-size: 12pt; border: 1px solid #BBB.
 

Heading Style
 

Enter any HTML style and class aributes you want the heading of your entire incident
thread to display.
 
By default, font-size: 12pt; border: 1px solid #CCC: background-color: #EOEAD8.
 

Dynamic Thread Content This section is used to dene the placement of your content and in which thread entries
to include the content. It applies only to the content displayed in the email message.
The options in this section apply only to the specic thread type.
 

Content Placement
 

The options in this drop-down menu dene the placement of your content—either
Before Thread Entry, which is selected by default, or After Thread Entry.
 

Inclusion
 

The options in this drop-down menu dene where in the incident thread your content
displays. Options include the following.

◦ Most Recent Entry—Displays your content in only the most recent thread of this
type. (Default)

◦ All Entries—Displays your content in every thread of this type.

◦ All Entries Except Most Recent—Displays your content in every thread of this type
except the most recent one.

6. Dene the content to include in addition to your incident thread using the HTML editor on the Thread Type
window. See How the HTML Editor Works.

7. Click OK to save your content and close the window. Notice that the Thread Properties window is still open.
8. Repeat steps 4 to 7 for each thread type your system uses.
9. To change the thread order to display the oldest threads rst, select Oldest to Newest in the Thread Order

drop-down menu in the Display section of the Thread Properties window. By default, the most recent threads
display.

10. To limit the number of threads that display, select Limit Thread Count in the Display section of the Thread
Properties window.

The Limit Thread Count check box is available only if the thread order is set to Newest to Oldest.

a. Enter the number of threads you want to display (up to 99) in the eld next to the Limit Thread Count
check box.

11. To truncate the text that displays within each thread (for all thread types), select Limit Text To in the Display
section of the Thread Properties window.

The Use Ellipsis check box is available only if the Limit Text To check box is selected.

a. Enter the number of characters you want to display in the eld next to the Limit Text To check box.
b. Select the Use Ellipsis check box to display an ellipsis (...) at the end of the truncated characters if the text

exceeds the set character limit.
12. Click OK to close the Thread Properties window.

Tip:  You may want to consider showing conditional content based on the number of threads that are
included within the sent message. See Dene Conditional Content Based on Message Thread Count.
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13. Add any other links or dynamic content you need to customize your message using the hyperlinks, buons,
dynamic content, and other features available on the HTML editor of the message template.

If an incident is triggered, all communication regarding the incident displays in your message.

Insert an Incident Link  
There are two ways you can link to incidents from Oracle Service Cloud. Inserting an Incident Link lets you link to any
incident you need to reference in the message sent to your customer. Inserting a Customer Portal Incident Link lets you
link to the incident that triggered the message.

1. Click  Incident Link in the Links section of the Toolbox.
The Incident Link window opens.

2. Enter eld information.

Field Description

Incident ID
 

Enter the incident ID for the incident you want to link to in this eld.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates

• Insert a Customer Portal Incident Link

How Merge Fields Work  
Merge elds let you look up account, asset, contact, incident, opportunity, organization, community, or tracked link
information and insert it in the text. For example, you could insert a merge eld for the rst name eld and have
contacts’ rst names appear in their mailing.
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You could also insert a number of incident elds for documents that are sent as a result of an incident rule or in a
campaign that uses an incident action. In the case where a merge eld value does not exist, you can specify a default
value. Additionally, you can add merge elds to a URL parameter. See Insert a Merge Field to a URL Parameter.

Another category of merge eld includes those that do not logically align with any of the other categories. These merge
elds are found in the Special Fields folder. Some let you insert merge elds related to certain conguration seings,
such as the number of hours an incident set to Waiting stays open or the amount of time in which an incident can be
reopened after it is solved. There are also special elds that let you personalize the Subject eld of the survey invitation
message by displaying the survey expiration date or the number of days until the survey expires. Other special elds
include interface name, generation time, SLA name, and merge elds related to community content. As with all merge
elds, those found in the Special Fields folder are context-sensitive to the type of content you are creating.

There are two ways merge eld content can be added: text and image. When you insert a text merge eld, you insert the
text from part of the record, such as a contact email address. See Insert a Text Merge Field. When you insert an image
merge eld, you insert the content from any text or text area custom eld into an <img> tag within the HTML where it
is displayed, such as a message template, mailing, survey, or answer. The custom eld should contain the absolute or
relative path to the image you want to display in the content. See Insert an Image Merge Field.

Insert a Text Merge Field  
Merge elds let you look up account, asset, contact, incident, opportunity, organization, community, or tracked link
information and insert it in the text. When you insert a text merge eld, you insert the text from part of the record, such
as a contact email address.

1. Click Merge Field in the Dynamic Content section of the Toolbox.
The Merge Field window opens.

2. Click the Type drop-down menu and select Text.
a. Enter eld information and values.

Field/Option Description

*Merge Fields
 

Select a database column from this list.
 

Default
 

Enter the default value of the merge eld in this eld. The default value is
used if a value does not exist for the eld in a contact record or incident. If
you want to include the eld only when a value exists, put the merge eld in a
conditional section.
 
This eld is not available when adding merge elds to a URL parameter.
 

Format
 

Click this drop-down menu to select the format. The options that display are
dynamic based on the type of merge eld you select.
 
This eld is not available when adding merge elds to a URL parameter.
 

Label
 

Enter a label that will display next to the merge eld in this eld.
 
This eld is not available when adding merge elds to a URL parameter.
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Field/Option Description

Limit Text To
 

Select this check box to truncate the text that displays as a result of a text-
based merge eld.
 
For elds that are not text-based, such as date elds, this check box does
not display. For social and discussion message templates (located under the
Discussion category of the Contact Emails message type), this eld is set
to 2500 characters, by default, on the Body merge eld that displays in the
template.
 

Characters
 

Enter the number of characters you want to allow in text-based merge elds.
This truncates the text that is sent in email messages.
 
This eld is available only if the Limit Text To check box is selected. For elds
that are not text-based, such as date elds, this eld does not display. For
social and discussion message templates (located under the Discussion
category of the Contact Emails message type), this eld is set to 2500
characters, by default, on the Body merge eld that displays in the template.
 

Use Ellipsis
 

Clear this check box to remove the ellipsis (...) from the end of the truncated
characters if the text exceeds the set character limit. This check box is
selected by default.
 
This check box is available only if the Limit Text To check box is selected. For
elds that are not text-based, such as date elds, this eld does not display.
 

b. Click OK.
3. Click Save.

Tip:  You can apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Insert an Image Merge Field  
Image merge elds let you insert the content from any text or text area custom eld into an <img> tag within the HTML
where it is displayed, such as a message template, mailing, survey, or answer.

Before you can insert an image merge eld to your content, you must add a custom eld to your knowledge base. See
Add or Edit a Custom Field.

The custom eld must contain the absolute or relative path to the image you want to display in the content.
1. Click Merge Field in the Dynamic Content section of the Toolbox.

The Merge Field window opens.
2. Click the Type drop-down menu and select Image.

a. Enter eld information and values.
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Field/Option Description

*Merge Fields
 

Select a text or text area custom eld from this list.
 

Note:  The values in the custom eld should contain the names of
images stored on your web server.

Default URL
 

Enter the default value of the merge eld. The default value is used if a
value does not exist for the custom eld in a record. The value should be an
absolute URL to an image (for example, hp://www.example.com/images/
logo.gif).
 

Base URL
 

Enter the base URL for the merge eld if you use relative URLs in the custom
eld. The value of the custom eld is appended to this URL. For example,
 if the base URL is hp://www.example.com/images/ and the value of the
custom eld is logo.gif, the result will be hp://www.example.com/images/
logo.gif. Leave this eld blank if the custom eld uses an absolute URL.
 

b. Click OK.
3. Click Save.

Tip:  You can apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Insert a Merge Field to a URL Parameter  
You can add merge elds to URL parameters you want to aach to links in your messages. URL parameters can be
dened on a mailing message, a survey invitation, or a tracked link. In these cases, the value of the merge eld is
appended to the URL as a parameter.

For example, if you wanted to pass the login eld value from the contact record, specifying hp://www.global.example/
regform.php?user=$contacts.login would return a URL such as hp://www.global.example/regform.php?user=jsmith.

1. Enter any parameters you want to append to the links in your message (for example, p1=v1&p2=v2) in the URL
Parameters eld located below the HTML editor.

2. Click the Merge Field icon to the right of the URL Parameters eld. The Merge Field window opens.
a. Select the database eld you want to merge. Merge elds are populated with data from the contact

record, account data or an associated incident, asset, opportunity, organization, or tracked link. You can
also use the special elds that are available.
The value of this eld is appended to the URL as a parameter.

b. Click OK to insert the merge eld with the appended URL parameter.

How Merge Reports Work  
In addition to merging data into your content one eld at a time, you can select and merge full reports. Then you can
lter the report output and edit its appearance. Merged reports extend data access to your marketing and survey
communications so you can develop more dynamic and contextually relevant content.

476



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

In most cases, a primary lter is applied to limit the report output so that customers see only their own information. For
example, if a report displays a list of all open incidents, customers see only their own open incidents when they view the
merged report. Primary lters are automatically applied in the following cases.

• contacts.c_id—Primary lter for any mailing (broadcast or transactional) and any survey invitation message. If
merging a report on a web page, the contact must be recognized by click-through parameters or cookies.

• incidents.i_id—Primary lter for any transactional mailing or survey that is sent using incident rules.

• opportunities.op_id—Primary lter for any transactional mailing or survey that is sent using opportunity rules.

• chats.chat_id—Primary lter for any transactional mailing or survey that is sent using chat rules.

In certain situations, you may want to disable the primary lter in the merged report, which can be done by clearing the
Automatically Apply Primary Filter check box on the Merge Report window. However, special handling is required to
ensure that the resulting data is appropriate for your audience. For example, if you want to include a report in a closed
incident survey listing each customer’s open incidents, the automatic primary lter can restrict the report to show only
the incident that triggered the survey. If you disable the primary lter, the report shows all incidents for all contacts. To
prevent this, you can manually add a primary lter by editing the report and adding a lter on contacts.c_id = ‘’. If you
then save the report and send the survey, the merged report lters on individual c_id values and displays to customers
only incidents associated with their contact record. (Filters can also be performed on incidents.i_id, opportunities.op_id,
and chats.chat_id, as needed.)

CAUTION:  Disabling the automatic primary lter removes safeguards intended to restrict the scope of the
report to the records related to the recipient. As a result, all data is returned for the report just as it would if
opened from the Reports explorer. Depending on how the report is congured, this can be processor intensive
and, in some cases, result in contacts receiving information related to other contacts. Unless a primary eld
lter has been added to the report, we recommend that this check box remain selected.

When merging a report into your content, you must select a preview contact to be used for ltering data on the Preview
tab of the content editor. This lter limits the data shown in the preview and provides a more accurate representation of
the nished content. You can also edit the merge report display properties and set a default value to be used when no
data is returned.

From the Preview tab, you can also use the optional Preview Contact eld to lter your preview by a particular contact.
This lets you see how your dynamic content, such as merge elds and conditional sections, looks in your content. For
example, if you have a conditional section for contacts in a specic postal code, you can preview your message to a
single contact who matches the postal code you specify to see if your conditional section works the way you intend it to.
This improves the accuracy of your messages and, ultimately, saves you time.

Merge a Report into Content  
Merge a report in the HTML editor in both HTML and text mode.

1. On the Design tab of the HTML editor, place the cursor where you want to position the report.
2. Click Merge Report in the Dynamic Content section of the Toolbox.

The Merge Report window opens listing all reports available in your prole.
3. Click the Search icon next to the Preview Contact eld. The Contact Search window opens where you can

search for a contact to use when the report is previewed on the content editor Preview tab.
a. Select the contact and click Select.

4. Select the report you want to merge into your content.
5. To disable the primary lter when the report is run, clear the Automatically Apply Primary Filter check box.

The check box is selected by default.
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CAUTION:  Disabling the primary lter removes the safeguards that restrict the scope of the report to
the records related to the recipient.

6. To edit the merge report properties, click the Properties tab and select a report format from the Output Type
drop-down menu.

For a description of each merge report property, see Merge Report Properties.

7. To specify a default value used when the report returns no information, click the Default tab and enter the
default value.

Tip:  You can also specify a default value after the report is merged by editing the contents of the
merge report placeholder.

8. Click OK.
The merge report placeholder is inserted into your content.

9. Click the Preview tab to see how your content looks.

Tip:  In documents, snippets, and templates, the optional Preview Contact eld lets you see how your
dynamic content that is specic to a contact looks. For example, if you have a conditional section
for customers in a specic postal code, you can preview a contact who matches the postal code you
specify to see if your conditional section works the way you intend it to. To preview by contact, repeat
step 3.

Merge Report Properties  
Merge report properties can be dened from the Properties tab of the Merge Report window when merging a report
into HTML content. In addition to merge report properties, other properties are available when merging into text
content.

Output Type/Field Description

Table
 

Select this output type to display the report data as a table in your content.
 

Max Rows
 

Enter the maximum number of rows for the table. Click the up or down arrow to increase or decrease
the value.
 

Table Properties
 

The seings in this section dene the appearance of the table when it is merged.
 

Caption
 

Enter the caption you want to appear at the top of the table.
 
This seing is also available when merging a report into text content.
 

Table Style
 

Enter any style aributes you want to apply to the table.
 

Table Class
 

Enter any class aributes you want to apply to the table.
 

Caption Style
 

Enter any style aributes you want to apply to the table caption. Style aributes dene how the text
appears, such as color and font (for example, color: red; font-weight: bold; font-style: italic).
 

Column Headers Select this check box to display column headers for the table.
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Output Type/Field Description

   
This seing is also available when merging a report into text content.
 

Column Header Style
 

Enter any style aributes you want to apply to the column headers. Style aributes dene how the text
appears, such as color and font (for example, color: red; font-weight: bold; font-style: italic).
 

Column Header Class
 

Enter the class name you want to apply to the column headers. You must dene the class in your HTML
content by either using the <style> tag to dene the class inline, or posting the class in a CSS le on
your web server and referencing it with the <link> tag.
 

Cell Style
 

Enter any style aributes you want to apply to the table cells. Style aributes dene how the text
appears, such as color and font (for example, color: red; font-weight: bold; font-style: italic).
 

Cell Class
 

Enter the class name you want to apply to the table cells. You must dene the class in your HTML
content by either using the <style> tag to dene the class inline, or posting the class in a CSS le on
your web server and referencing it with the <link> tag.
 

Cell Format
 

Click this drop-down menu to select a case format for cells in the table.
 
This seing is also available when merging a report into text content.
 

Width
 

Enter the width of the table and select pixels or percent from the drop-down menu.
 

Border
 

Enter the width, in pixels, of the table border.
 

Frame
 

Click this drop-down menu to apply an HTML style to your frame. Options include the following.
 
Void—Outside borders are not shown.
 
Above—Top outside border is shown.
 
Below—Boom outside border is shown.
 
Hsides—Top and boom outside borders are shown.
 
Vsides—Left and right outside borders are shown.
 
Lhs—Left outside border is shown.
 
Rhs—Right outside border is shown.
 
Box—Outside borders are shown on all four sides.
 
Border—Outside borders are shown on all four sides.
 

Rules
 

Click this drop-down menu to apply an HTML style to the lines in your table. Options include the
following.
 
None—No lines are shown.
 
Groups—Lines are shown between row groups and column groups.
 
Rows—Lines are shown between rows.
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Output Type/Field Description

Cols—Lines are shown between columns.
 
All—Lines are shown between rows and columns.
 

Cell Padding
 

Enter the padding, in pixels, of the table cells.
 

Cell Spacing
 

Enter the spacing, in pixels, of the table cells.
 

Primary Background Color
 

Click this color box to select a primary color for the cell background or enter the HTML hexadecimal
value of the color in the eld to the right of the color box.
 

Alternating Background Color
 

Click this color box to select a primary color for the cell background or enter the HTML hexadecimal
value of the color in the eld to the right of the color box.
 

Border Color
 

Click this color box to select a primary color for the cell background or enter the HTML hexadecimal
value of the color in the eld to the right of the color box.
 

List
 

Select this output type to display the report data as a list in your content.
 

Max Rows
 

Enter the maximum number of rows for the list. Click the up or down arrow to increase or decrease the
value.
 

List Type
 

Select the option next to the type of list you want to display.
 

Ordered List
 

Select this option to display a numbered list.
 

Unordered List
 

Select this option to display a bulleted list.
 

List Style
 

Enter any style aributes you want to apply to the list text. Style aributes dene how the text appears,
such as color and font (for example, color: red; font-weight: bold; font-style: italic).
 

List Class
 

Enter the class name you want to apply to the list text. You must dene the class in your HTML content
by either using the <style> tag to dene the class inline, or posting the class in a CSS le on your web
server and referencing it with the <link> tag.
 

Format
 

Click this drop-down menu to select a case format for the list text. The available options are Lowercase,
Uppercase, and Proper Case.
 
This seing is also available when merging a report into text content.
 

Single Value
 

Select this output type to display only the value of the eld in rst row and rst column of your report
content.
 

Format
 

Click this drop-down menu to select a case format for the single value text. The available options are
Lowercase, Uppercase, and Proper Case.
 
This seing is also available when merging a report into text content.
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Output Type/Field Description

Style
 

Enter any style aributes you want to apply to the single value output. Style aributes dene how the
text appears, such as color and font (for example, color: red; font-weight: bold; font-style: italic).
 

Class
 

Enter the class name you want to apply to the single value output. You must dene the class in your
HTML content by either using the <style> tag to dene the class inline, or posting the class in a CSS le
on your web server and referencing it with the <link> tag.
 

Note:  Regarding class aributes, because few third-party mail clients consistently support CSS, you should
use style aributes instead of CSS.

Related Topics
• Merge a Report into Content

Insert a Physical Address  
You can include a physical address in your HTML so it passes CAN-SPAM requirements by entering it in a separate area.

1. Click Insert Address in the Content section of Tasks.
The Insert Address window opens.

2. Enter the physical address of your organization in the Sender’s Postal Address eld.
3. Click OK.

Your address is added to its own section in the document.

Tip:  You can apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Related Topics
• CAN-SPAM Compliance

Insert a Prole Link  
Prole links let you link to the Account Seings page on your customer portal where customers can change their user
name and update their prole information.

1. Click Prole Link in the Links section of the Toolbox.
The Prole Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
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Field Description

 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Congure the Account Seings Page

Insert a Proof Comments Link  
A Proof Comments Link lets you add a link to a web page where the recipient can give feedback about the survey they
have been asked to proofread.

For instance, you might want to add comment elds to gather feedback about specic parts of your message rather
than the message as a whole. The Survey Proof message template is dened in message templates.

1. Click Proof Comments Link in the Links section of the Toolbox.
The Proof Comments Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML document by either using the <style> tag to dene the class inline,
 or posting the class in a CSS le on your web server and referencing it with the <link>
tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
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Field Description

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates

Insert a Proof Survey Link  
Inserting a Proof Survey Link lets you add a link to the survey that you want your proofreaders to review.

Unlike broadcast and transactional surveys that include a survey link and a comment eld in the invitation message
sent as part of the proof message, website link surveys rely on the message that is dened by the Survey Proof message
template. The Proof Survey Link is included, by default, on the Survey Proof message template.

1. Click Proof Survey Link in the Links section of the Toolbox.
The Proof Survey Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates
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Insert a Reset Password Link  
Reset password links let you link to the Account Assistance page on your customer portal. If any of your recipients do
not yet have a password dened in their contact record, providing a reset password link can help them gain access to
the customer portal.

1. Click Reset Password in the Links section of the Toolbox.
The End User Reset Password Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Insert a Setup Password Link  
Setup password links let you link to the Finish Account Creation page on the customer portal, which also displays a link
to the Account Assistance page.

1. Click Setup Password Link in the Links section of the Toolbox.
The Setup Password Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
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Field Description

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Insert a Survey Link  
There are two ways you can link to surveys from Oracle Service Cloud—a Survey Link or a Link to This Survey.

From mailings, documents, and certain message templates, you can insert a Survey Link to add a link to any existing
survey listed in your Surveys explorer. From a survey, you can insert a Link to This Survey to add a link to the survey
you have open. The Link to This Survey is included, by default, on the survey invitation message when you create a new
survey.

1. From a document, mailing or message template, click Survey Link in the Links section of the Toolbox.
The Survey Link window opens.

2. Enter eld information.

Field/Option Description

*Surveys
 

Select a survey from this list. See Create a Survey.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS for content included in mailings.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
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Field/Option Description

 

3. Click OK.

Related Topics
• Overview of Message Templates

• Insert a Link to This Survey

Insert a Link to This Survey  
There are two ways you can link to surveys from Oracle Service Cloud—a Link to This Survey or a Survey Link.

From a survey, you can insert a Link to This Survey that adds a link to the survey you have open. The Link to This Survey
is included, by default, on the survey invitation message when you create a new survey. From mailings, documents, and
certain message templates, you can insert a Survey Link that lets you add a link to any existing survey listed in your
Surveys explorer.

1. From a survey Invitation Message tab, click Link to This Survey in the Links section of the Toolbox.
The Link to This Survey window opens.

2. Enter eld information.

Field/Option Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS for content included in mailings.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates

• Insert a Survey Link
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Insert a Survey Results Link  
Inserting a Survey Results Link lets you link to a web page showing the survey responses. The Survey Results Link is
included, by default, on the Survey Notication message template.

1. Click Survey Results Link in the Links section of the Toolbox.
The Survey Results Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates

Insert a Table  
You can insert a table in your HTML and dene the number of rows and columns, its border properties, cell padding,
and cell spacing.

1. Click Table in the HTML section of the Toolbox.
The Insert Table window opens.

2. To insert a table from the Quick tab, hover over and click on the grid to dene the number of rows and columns
in the table.
The table is inserted into your document.

3. To insert a table from the Advanced tab, click the Advanced tab.
a. Enter eld information.

487



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

Size
 

Dene the size of the table in this section.
 

Rows
 

Enter the number of rows in the table.
 

Columns
 

Enter the number of columns in the table.
 

Table Width
 

Enter the width of the table and select pixels or percent from the drop-down
menu.
 

Display
 

Dene the table aributes in this section.
 

Border
 

Enter the width, in pixels, of the table border.
 

Cell Padding
 

Enter the padding, in pixels, of the table cells.
 

Cell Spacing
 

Enter the spacing, in pixels, of the table cells.
 

b. Click OK to insert the table.
4. To edit the table properties, right-click the table and select  Table Editor > Table Properties . The Table Editor

window opens.
a. Enter eld information.

Field Description

Caption Properties
 

Dene the table caption in this section.
 

Caption
 

Enter the caption of the table.
 

Alignment
 

Click this drop-down menu and select the alignment of the caption. Your
choices are Inline, Left, Centered, and Right. The default alignment is Inline.
 

Location
 

Click this drop-down menu and select the location of the caption in relation
to the table. Your choices are Top and Boom.
 

Table Properties
 

Dene the table aributes in this section.
 

Border Enter the width, in pixels, of the table border.
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Field Description

   

Alignment
 

Click this drop-down menu and select the alignment of the table on the page.
Your choices are Inline, Left, Centered, and Right. The default alignment is
Inline.
 

Width
 

Enter the width of the table and select the unit from the options (Pixels or
Percentage).
 

Background Color
 

Click the color box to select a color for the table background or enter the
HTML hexadecimal value of the color in the eld to the right of the color box.
 

Border Color
 

Click the color box to select a color for the table borders or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

Cell Properties
 

Dene the table aributes in this section.
 

Cell Spacing
 

Enter the spacing, in pixels, of the table cells.
 

Cell Padding
 

Enter the padding, in pixels, of the table cells.
 

b. Click OK.

Tip:  A list of additional options for adding and removing rows and columns are available by right-
clicking the table and selecting Table Editor.

5. To edit cell properties, right-click the table cell and select  Table Editor > Cell Properties . The Cell Properties
window opens.

a. Enter eld information.

Field Description

Border Properties Dene the cell border properties in this section.

Border
 

Enter the width of the cell border in pixels.
 

Border Color
 

Click the color box to select a color for the cell borders or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

Layout Dene the cell layout in this section.
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Field Description

Width
 

Enter the width of the cell in pixels or as a percentage of the table and select
the corresponding unit from the drop-down menu.
 

Horizontal Alignment
 

Click this drop-down menu and select the horizontal alignment of the text in
the cell. Your choices are Inline, Left, Centered, Right, and Justify. The default
alignment is Inline.
 

Vertical Alignment
 

Click this drop-down menu and select the vertical alignment of the text in the
cell. Your choices are Top, Middle, Boom, and Baseline.
 

Background Color
 

Click the color box to select a color for the cell background or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

Word Wrap
 

Select this check box to allow text to wrap in the cell.
 

b. Click OK.

Tip:  Additional options for inserting, merging, spliing, and deleting cells are available by right-
clicking the table and selecting Table Editor.

Insert a This Answer Link  
There are two ways you can link to answers from Oracle Service Cloud. Inserting an Answer Link lets you link to any
answer you need to reference in the message sent to your customer. Inserting a This Answer Link lets you link to the
answer that triggered the sent message.

Both the Answer Link and This Answer Link are included, by default, on any answer-related message template.

1. Click This Answer Link in the Links section of the Toolbox.
The This Answer Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.
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Field Description

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

Use Summary As Link Text
 

Select this check box to use the answer summary as the text you want to appear as the
link.
 

3. Click OK.

Related Topics
• Overview of Message Templates

• Insert an Answer Link

Insert a This Discussion Link  
Inserting a This Discussion Link lets you add a link to your message that customers can use to access the message that
triggered the sent email.

The This Discussion Link is included, by default, on any contact email message template that is related to community
content.

1. Click This Discussion Link in the Links section of the Toolbox.
The This Discussion Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
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Field Description

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates

Insert a Tracked Link  
Tracked links let you track the number of link clicks in your survey, mailing, or web page. You can also use tracked links
in several of the standard system-generated contact email messages. Adding tracked links to your contact emails are
especially useful in tracking your customer-facing incident responses.

You must dene your tracked links before you can insert them in your HTML.
1. Click Tracked Link in the Links section of the Toolbox.

The Tracked Link window opens.
2. Enter eld information.

Field/Option Description

*Tracked Links
 

Select a tracked link from this list.
 

New Tracked Link
 

Click this text to create a tracked link. The tracked link is selected in the menu after
being added. See Add a Tracked Link.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

492



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

3. Click OK.

Tip:  You can also apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Related Topics
• Incident Response Tracking

Convert Links to Tracked Links  
When a document, template, snippet, or notication with HTML content is saved, you can choose to convert the links in
the HTML to tracked links.

Oracle Service Cloud automatically nds any links by searching for HTML anchor tags with an href aribute that do not
begin with “mailto:” or “#.” In addition, the system nds links that are part of an image map by searching for HTML area
tags with an href aribute. When you save, the system searches for links and prompts you to convert them to tracked
links. After you conrm, the links are validated and converted to tracked links. The tracked links are named using the
link text and the URL. For example, the link “<a href=hp://oracle.com/>Oracle Home Page</a>” will be named “Oracle
Home Page – oracle.com.” If the link is an image or part of an image map, the name includes “[Image: <image_name>]”
or “[Image Map: <image_name>].”

1. Save the document, template, or snippet.
The HTML content is scanned and the Tracked Link Conversion message opens if links are found.

2. Click Yes to convert the links to tracked links.
The Convert Tracked Links window opens. Each link in the document is validated and the results display in the
window.

3. Enter eld information.

Field Description

Link Name
 

This column lists the names of the tracked links created from the HTML links.
 

Link Target
 

This column lists the URLs of the tracked links. You can open the link in a browser by
clicking the link target.
 

Status
 

This column lists the status of the link validation. The status can be Valid, Broken, or
Validating.
 

Action
 

Click Edit in this column to edit the tracked link name and target.
 

Check All
 

Click this text to select all check boxes in the list of tracked links. Selected links are
converted.
 

Uncheck All
 

Click this text to clear all check boxes in the list of tracked links. Cleared links are not
converted.
 

4. Select the links you want to convert by clicking the check boxes next to the link names.
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5. To edit the name and URL of a link, click Edit. The Edit Tracked Link window opens.
a. Enter the name of the tracked link in the Link Name eld.
b. Enter the URL of the tracked link in the Link Target eld.
c. To open the link in a web browser, click the View URL in Web Browser icon.
d. Click OK to save changes to the tracked link.

6. Click OK to convert the selected tracked links.

Note:  The tracked links can be viewed or edited from the Tracked Links explorer. The links are stored
in a folder named “Automatically Generated” and a subfolder named by the date the conversion was
done (YYYY MM DD).

Related Topics
• Automatically Generated Folders

• Add a Tracked Link

Insert an Unsubscribe All Answers Link  
Inserting an Unsubscribe All Answers Link lets you add a link that contacts who receive answer notications can use to
unsubscribe from future communications.

Answer notication messages are dened in message templates.

1. Click Unsubscribe All Answers Link in the Links section of the Toolbox.
The Unsubscribe From All Notications Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK to insert the unsubscribe all answers link.
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Related Topics
• Overview of Message Templates

Insert an Unsubscribe Link  
Unsubscribe links let your contacts opt out of future mailings and surveys.

You can create an unsubscribe link that allows them to globally opt out of all future mailings and surveys, opt out of
surveys only, or opt out of audiences dened by a custom opt-in eld. You can unsubscribe contacts with a single click
of the link, or direct them to a page to conrm that they want to unsubscribe. When prompting for conrmation, you
can choose to set the opt-in eld to No either before or after contacts conrm through the Unsubscribe page.

Note:  All mailings include a List-Unsubscribe mail header which some mail clients use to automatically
provide an unsubscribe link when the message is viewed by a recipient. However, because this header is
not supported by all mail clients, you should add an unsubscribe link to your message, as described in this
procedure.

1. Click Unsubscribe Link in the Links section of the Toolbox.
The Unsubscribe Link window opens.

2. Enter eld information.

Field Description

*Opt-in Field
 

Click this drop-down menu to select a previously dened custom opt-in eld, select
Survey Opt-in to let contacts unsubscribe from surveys, or select Global Opt-in to let
contacts unsubscribe from all mailings and surveys. The default option is Global Opt-in.
See Contact Opt-In Management.
 

*Mode
 

Click this drop-down menu to select how the link functions. You can select from three
options:
 

◦ “One Click” sets all global, survey, and custom opt-in elds to No when contacts
click the link.

◦ “Prompt, then set eld” opens a web page where contacts must conrm their
choice to unsubscribe before the eld is set.

◦ “Set eld, then prompt” also opens a web page to conrm, but the eld is set rst.

The default option is One Click.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.
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Field Description

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Tip:  You can also apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Insert an Unsubscribe This Answer Link  
When you use answer sections to display repeatable content on the Answer Update Notication message template, an
Unsubscribe This Answer Link is included, by default, inside the answer section. This link adds an unsubscribe link to
each answer that is included in the email notication.

The Unsubscribe This Answer Link is available only on the Answer Update Notication message template.

1. Click Unsubscribe This Answer Link in the Links section of the Toolbox.
The Unsubscribe From Notication Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK to insert the unsubscribe this answer link.
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Tip:  You can also apply style and class aributes by right-clicking an element after you add it to the
canvas. See Edit Style and Class.

Related Topics
• Overview of Message Templates

• Insert an Answer Section

Insert a View Subscriptions Link  
Inserting a View Subscriptions Link lets you add a link to your messages that customers can use to see the list of
subscriptions they have to your content and to update that list if needed.

The View Subscriptions Link is included, by default, on any contact email message template related to subscription
notications, such as answer and community update (discussion) subscriptions.

1. Click View Subscriptions Link in the Links section of the Toolbox.
The View Subscriptions Link window opens.

2. Enter eld information.

Field Description

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK.

Related Topics
• Overview of Message Templates
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Insert a Web Form  
When creating HTML content, you have the option to add web forms to collect customer data. You can add any
database contact eld, contact custom eld, or survey question to the web form, leing you populate a contact record
based on the submied form.

A contact record is created each time a contact submits a form, unless any of the following occurs: the email address
is included in the form, cookies are set through a survey or campaign, or the contact opens the form from a link in a
mailing. If an email address exists or the repeat visitor has a cookie set for the form, the contact record is updated rather
than creating a new record. If email address sharing is enabled and the email address is shared by multiple contacts, the
web form submission is associated with the contact deemed to be the best t. See Email Address Sharing.

Also, if a contact submits a value for Organization Name (contacts.ma_org_name) in a web form, Oracle Service Cloud
searches existing organization records for a match. If a match is found, the contact is associated to the matching
organization.

Note:  There is no client-side validation when a web form is used in an email. For security reasons, most email
clients disallow the submission of forms from email messages. Therefore, embedding a web form in the body
of a mailing or survey invitation message can result in an extremely low submission rate. As an alternative, we
recommend creating the web form in a served web page and including a link to the page in your message. See
Edit Serve Web Page Aributes.

You can also insert standard HTML objects in the form, such as images and tables, and click and drag form elements
into place through the HTML editor. When you nish the web form, you can add a Submit buon with one click.

1. From a document, click Web Form in the Forms section of the Toolbox.
The web form section is added to the HTML content bordered by an orange doed line.

2. Insert the cursor in the web form section and click Form Field to insert a eld.
The Form Field window opens.

3. Enter eld information.

Field/Option Description

*Web Form Fields
 

Select a database eld from this list.
 

Default Value
 

Select this check box to add a default value for the eld and then type or select the value
from the text box.
 

Required
 

Select this check box to make the eld required.
 

Note:  You must add your own visual indicator that the eld is required (for
example, *).

Class
 

Enter the class name you want to assign to the eld. You must dene the class in the
HTML of your document by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
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Field/Option Description

Because few third-party mail clients consistently support CSS, you should use style
aributes instead of CSS.
 

Style
 

Enter any style aributes you want to assign to the eld in this text box. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Label
 

Enter a label for the eld as you want it to display. The default label is the name of the
web form eld.
 

Display As
 

If an opt-in eld or radio custom eld is selected, select Radio Buons or Check Boxes to
select how to display the eld in the web form.
 

Note:  Custom eld masks are not enforced in web forms.

4. Click OK to insert the eld.
5. To add a survey question, click Survey Question. The Survey Question window opens.

a. Select a survey question from the Questions list.
b. To create a question, click New Survey Question.

A window opens where you can create a question. See How Questions Work.
c. To show the question and the answer as two separate elds on the web form, select the Split Question

and Answer Tag check box. This lets you control where the question and answer portions of the question
display.

d. Click OK to insert the question.
6. Click Submit Buon to add the Submit buon to the web form.

Note:  You must include a Submit buon with the form. If using your own HTML code, you must
include the aributes used in the Submit buon. Therefore, we recommend that you use the HTML
editor to insert the Submit buon. You can double-click the buon to edit the buon text, or switch to
source mode to use advanced options such as using an image for the buon.

After you add a web form to a document and serve the document in a campaign or survey, you can modify the URL of
the web form page to include parameters to prell one or more of the elds on the form.

Related Topics
• Web Form and Survey Security

• Prell Web Form Fields

Insert a Web Page Link  
Web page links let you link to another document in Oracle Service Cloud. When you create a campaign that serves a web
page as an action, you make the page available to link to.

1. From a document, mailing, or survey, click Web Page Link in the Links section of the Toolbox.
The Web Page Link window opens.
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Note:  Your campaign must be launched for it to appear in the Web Page Links list. See Launch or
Suspend a Campaign.

2. Enter eld information.

Field/Option Description

*Web Page Links
 

Select a web page from this list. See Edit Serve Web Page Aributes for information
about web pages served in campaigns.
 

*Text
 

Enter the text you want to appear as the link in this eld.
 

Class
 

Enter any class name you want to assign to the link in this eld. You must dene the
class in your HTML content by either using the <style> tag to dene the class inline, or
posting the class in a CSS le on your web server and referencing it with the <link> tag.
 

Note:  Because few third-party mail clients consistently support CSS, you
should use style aributes instead of CSS for content included in mailings.

Style
 

Enter any style aributes you want to assign to the link in this eld. Style aributes
dene how the text appears, such as color and font (for example, color: red; font-weight:
bold; font-style: italic).
 

Target
 

Click this drop-down menu and select the target for the link: New Window, Same
Window, Parent Window, or Browser Window.
 

3. Click OK to insert the web page link.

Related Topics
• Create a Campaign

Add HTML in Source Mode  
The HTML editor contains an option to create your documents using HTML code. You can enter HTML code directly in
the editor to create your content.

The editor displays your code using colored text to indicate structure and syntax. There are additional functions
available that you can access through the Toolbox and Tasks sections. The links and dynamic content elements that
display on the HTML editor are context-sensitive and depend on what type of content you are creating. When you save,
the system automatically validates your code formaing and noties you about any errors.
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Note:  By default, the editor requires your code to be XHTML compliant before it can be saved. To allow code
to be saved without XHTML compliance, disable the HTML_TIDY_ENFORCE_XHTML conguration seing
(RightNow User Interface/Misc. Customization/HTML Editor).

1. Click the Source tab at the boom of the HTML editor.

Source mode automatically places the cursor after the opening <body> tag. This image shows the HTML editor
in source mode with the HTML tab selected.

The Source tab has a toolbar and a section for entering your source code. Using the toolbar, you can create
HTML using some of the same options available in basic word processing applications. Functions include:

◦ Cut, copy, and paste

◦ Find and replace text

◦ Print the document

◦ Undo and redo changes

◦ Switch to full screen

◦ Enable or disable syntax highlighting

Tip:  It’s a good idea to preview your work when using Source mode. When you switch between the
Source and Preview tabs, your cursor stays where you left it, making it easy to check your work. See
Preview Content.

Additional functions are accessed through the Toolbox and Tasks sections. You can insert HTML by clicking
a buon in the Toolbox or Tasks section, or by dragging and dropping the buon to a specic location on the
canvas. For detailed information about these functions, see the Toolbox Section and Tasks Section tables in
Links and Dynamic Content Elements.

Preview Content  
You can preview the HTML and text versions of your content. The content displays as customers will see it in their email
client or on a web page.

1. Click the Preview tab at the boom of the HTML editor.
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2. To see how your dynamic content displays, either by incident or contact, click the Search icon next to the
Preview Incident or Preview Contact eld.

The Search window opens where you can search for an incident or a contact to use when the message is
previewed on the Preview tab.

How You Create and Edit Text-Only Messages  
You can create text-only messages for your customers who can receive only plain text emails.

Unlike the HTML editor, the text editor does not contain text formaing options. It does, however, contain links for
additional functions related to Oracle Service Cloud, such as adding a merge eld, or conditional section. You can also
add several types of links to your content. When a link is added, you have the option of dening certain aributes
depending on the type of link. Links in plain text cannot be clicked and customers need to copy the URL into their web
browser.

Using the toolbar, you can use several of the same options available in basic word processing applications. Functions
include:

• Cut, copy, and paste

• Find and replace text

• Print the document

• Undo and redo changes

• Switch to full screen

• Enable or disable syntax highlighting

Additional functions are accessed through the Toolbox and Tasks sections.

Buon Description

Links Buons in this section are used to insert links in your content.

Account Assistance Link
 

Click this buon to insert a link to the Account Assistance page on your customer portal. See Insert an
Account Assistance Link.
 

Agent Browser UI Incident Link
 

Inserts a link to the incident that triggered the sent message so that agents can access the incident
from the Agent Browser User Interface. See Insert an Agent Browser UI Incident Link.
 

Answer Link
 

Click this buon to insert a link to any answer you specify. See Insert an Answer Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Browser Link
 

Click this buon to insert a browser link. See Insert a Browser Link.
 

Chat Link
 

Click this buon to insert a link to the Live Help page on the customer portal. See Insert a Chat Link.
 
This buon is available only if Chat is enabled.
 

Cloud Link
 

Click this buon to insert a link to a social media service. See Insert a Cloud Link.
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Buon Description

Customer Portal Incident Link
 

Click this buon to insert a link to the incident that triggered the sent message. For example, the
standard Question Receipt email sends a conrmation message after a customer submits a question
through the Ask a Question page, an email, or a chat session. By adding a Customer Portal Incident
Link to your Question Receipt message template, you can provide your customers with easy access to
the incident created from their question. See Insert a Customer Portal Incident Link.
 

File Link
 

Click this buon to insert a le link. See Insert a File Link.
 

Forward to Friend Link
 

Click this buon to insert a forward to friend link. See Insert a Forward to Friend Link.
 

Incident Link
 

Click this buon to insert a link to any incident you specify. See Insert an Incident Link.
 

Prole Link
 

Click this buon to insert a link to the Account Seings page on your customer portal. See Insert a
Prole Link.
 

Reset Password
 

Click this buon to insert a reset password link. See Insert a Reset Password Link.
 

Setup Password
 

Click this buon to insert a link to the Finish Account Creation page on your customer portal. See Insert
a Setup Password Link.
 

Survey Link
 

Click this buon to insert a link to an existing survey. See Insert a Survey Link.
 

This Answer Link
 

Click this buon to insert a link to the incident that triggered the sent message. See Insert a This
Answer Link.
 

This Discussion Link
 

Click this buon to insert a link to the email discussion that triggered the sent message. See Insert a
This Discussion Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Tracked Link
 

Click this buon to insert a tracked link. See Insert a Tracked Link.
 

Unsubscribe All Answers Link
 

Click this buon to insert a link that lets contacts who receive answer notications unsubscribe from
future communications. See Insert an Unsubscribe All Answers Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Unsubscribe Link
 

Click this buon to insert an unsubscribe link. See Insert an Unsubscribe Link.
 

Unsubscribe This Answer Link
 

Click this buon to insert an unsubscribe link to a specic answer that’s been returned as the result of a
repeatable answer section. See Insert an Unsubscribe This Answer Link.
 
This buon is available only on the Answer Update Notication message template. See How You
Customize Messages.
 

View Subscriptions Link
 

Click this buon to insert a link customers can use to update the list of social notications they are
subscribed to. See Insert a View Subscriptions Link.
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Buon Description

This buon is available only in message templates. See How You Customize Messages.
 

Web Page Link
 

Click this buon to insert a web page link. See Insert a Web Page Link.
 

Dynamic Content Buons in this section are used to insert dynamic content.

Answer Section
 

Click this buon to add any repeatable answer details on your answer update notication messages.
See Insert an Answer Section.
 
This buon is available only in message templates. See How You Customize Messages.
 

Case Section
 

Click this buon to add a case section to your conditional text. See Insert a Case Section.
 

Conditional Section
 

Click this buon to insert a section of conditional text. See Insert a Conditional Section.
 

Incident Thread
 

Click this buon to insert an incident thread that displays all communication between the parties
associated with the message. See Insert an Incident Thread.
 

Merge Field
 

Click this buon to insert a merge eld. See Insert a Text Merge Field.
 

Merge Report
 

Click this buon to insert a merge report. See Merge a Report into Content.
 

Start Over Buons in this section are used to clear all content and start over.

Use Existing
 

Click this buon to clear all content and start over with an existing document.
 

Convert HTML
 

Click this buon to clear all text and start over with a converted HTML le. See Create Text Content in
Documents.
 

Content Buons in this section are used to insert snippets and symbols.

Insert Snippet
 

Click this buon to insert a snippet. See Create a Snippet.
 

Insert Symbol
 

Click this buon to insert a special symbol. A symbol map opens. Double-click the symbol you want to
insert.
 

Insert Address
 

Click this buon to insert a physical address. See Insert a Physical Address.
 

Note:  The CAN-SPAM Act of 2003 requires that commercial email messages contain the
sender’s valid physical postal address.
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Organizations  

Overview of Organizations  
Organization records provide a complete view of all activity for an organization and all the contacts, incidents,
opportunities, and tasks associated with that organization.

Perhaps you have multiple customers from one organization. For example, a sales representative might have an
opportunity that involves engineers, purchasing agents, and support managers from one organization. In those
situations, it is vital to have a complete overview of all activity within the organization. An organization is a business
entity with an organization record in the knowledge base. Organizations can refer to companies, divisions of companies,
government agencies, educational institutions, or nonprot associations.

Organization records are an optional way of consolidating customer information, but if you have several individual
customers who belong to one organization, maintaining that information in an organization record is an ecient and
eective way to group data. For example, if you work for a cell phone company that provides products and services only
to individual consumers, you do not need organization records in the knowledge base. If, however, you sell to business
accounts that distribute cell phones to their employees, it makes sense to group all of those employees (each with an
individual contact record) under the organization they are associated with. This links the data associated with each of
the contacts to the organization, providing you with a single-source view of all activity within the organization.

By denition, an organization can have an unlimited number of contacts. A contact, on the other hand, can be
associated with only one organization. Organizations can be structured in a hierarchy that enables you to add
subsidiaries, divisions, or regional oces to accurately reect all areas of the organization.

The customer portal in Oracle RightNow Cloud Service (Service) can be congured so contacts can view all incidents
associated with their organization. When contacts view other incidents, they can often nd answers to their questions,
which reduces the number of incidents they submit. See Conguring Oracle Service Cloud for Customer Portal.

When your knowledge base contains organization records, you can track a specic organization’s incidents and see
trends or problem areas. You can view all of the incidents for the organization from the organization record without
having to select each contact individually. Likewise, you can view all opportunities, tasks, aachments, and notes
associated with the organization, and view all changes that have been made to the organization record using the audit
log.

How SLAs Work with Organizations and Contacts  
A service level agreement (SLA) is a contract that can be applied to customers, both organizations and contacts, in
Service.

SLAs let you specify and track the level and type of support a customer is eligible to receive. For example, an SLA
might include the number of questions that can be submied through dierent channels and the duration of support.
Administrators create generic SLAs (that is, an SLA template) that can then be applied to specic customers. An SLA
instance is a copy of the generic SLA applied to a unique customer. SLA instances can be applied automatically through
business rules or manually by sta members. Familiarize yourself with the following points before adding or editing
organizations.

• SLAs can be applied to contacts and organizations. Contacts that are not associated with an organization
can have their own SLA instances. However, contacts that are associated with an organization do not have
individual SLA instances. Instead, they are covered under the SLAs applied to their organization.
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• Customers can view and track their SLAs on the Account Overview page of the customer portal, where SLAs
are called contracts. Depending on how your administrator has congured the customer portal, all contacts
associated with an organization may be able to view the responses to questions submied by all contacts within
their organization.

• Your administrator can set up business rules to automatically apply SLA instances to organizations or contacts
when incidents enter the system (from the Ask a Question page, email, or chat). After applying an SLA instance,
business rules can then credit the incident to the specic SLA.

• If your organization uses SLAs and you have SLA permissions set in your prole, part of your duties may be to
apply SLA instances to organizations and to contacts that do not have an organization association. See SLA
Instance Field for specic instructions about applying SLA instances.

Standard Organization Workspace  
Oracle Service Cloud provides a standard workspace for working with organizations.

The workspace denes which elds are available, what buons are displayed on the ribbon, and how the information
is organized on the content pane. Your organization may use the standard workspace, or your administrator may
have created one or more customized workspaces. Your prole denes the workspace you see when you work with
organizations, whether it is the standard workspace or a customized workspace. See Standard Workspaces or Custom
Workspaces.

Organization Workspace Ribbon  
The buons on the standard organization workspace ribbon are used to perform actions on the workspace.

For information about the ribbon in general, see Common Functionality Ribbon.

Group/Buon Description

Editor

Undock Click to undock the organization editor from the console and display it in a separate window.

Save

Save Click to save the changes you have made to the organization and continue working. The organization
record remains open.
When you save an organization, the rules engine evaluates it. If organization rules exist and the
organization matches one or more rules, the record may be modied when you save it. For example, a
rule can change an organization’s state or set a custom eld value. See Overview of Business Rules.
 

Save and Close Click to save the organization and close the record.

Actions
With the exception of the New and Appointment buons, the buons in this group are not enabled until after you have saved an organization you
are adding.
 

New Click to add an organization.
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Group/Buon Description

Refresh Click to refresh the current organizations report.

Appointment Click to add an appointment that is associated with the organization. See Record Information Available
in Outlook Appointments.

Print Click to print the organization record. See Print a Record.

Copy Click to copy the organization record. See Copy a Record.

Delete CAUTION:  Deleting an organization permanently removes all contacts associated with the
organization from the knowledge base. It also deletes all incidents for which the contacts are
the primary contacts, and it may delete opportunities as well. See What Happens When You
Delete a Contact.

Click to delete the organization record.
 

Proong

Spell Check Click to check the spelling of any elds that have spell checking enabled. See Check Spelling Manually.

Links and Info

Links Click to select a URL from the list of links added by your administrator.

Info Click to see details about the organization, including when it was added and last updated and the
record ID. If the organization record is in a rules state, that information also appears.

Related Topics
• Common Functionality Ribbon

• Display Shortcut Keys on the Ribbon

Organization Workspace Record Tabs  
From an open organization record, you can view all contacts, tasks, aachments, notes, incidents, opportunities,
and the organization’s position in a hierarchy. You can also view the audit log, which lists all actions taken on the
organization record.

• Contacts —Lists all contacts associated with the organization. The number of contacts associated with the
organization displays in parentheses next to the tab name. For each contact, the tab displays the name,
email address, organization name, oce phone number, and title. You can open, print, copy, remove from
the organization, send an email, and set the contact role from the Contacts tab. See Add New Contacts to an
Organization.

Note:  Contact roles are used only in opportunity tracking.

• Opportunities —Lists all opportunities associated with the organization. The number of opportunities
associated with the organization displays in parentheses next to the tab name. For each opportunity, the tab
displays the opportunity name, the sta person it is assigned to, status, stage, the sales representative forecast,
the manager forecast, and the date it was last updated. You can open, copy, delete, print, forward, and reject an
opportunity from the Opportunities tab. See Overview of Opportunities.

• Notes —Contains all notes associated with the organization. Notes can be sorted by date. Remember that
customers never see the notes added by sta members. See Add an Organization.

507



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

• Tasks —Lists all tasks associated with the organization. The number of tasks associated with the organization
displays in parentheses next to the tab name. For each task, the tab displays the task name, due date,
completion date, sta member assigned to the task, and priority. You can open, copy, delete, print, and forward
any task and mark tasks complete by clicking a buon on the tab’s toolbar or by right-clicking the task and
making your selection. See Add a Task.

• Incidents —Lists all incidents associated with the organization. The number of incidents associated with the
organization displays in parentheses next to the tab name. For each incident, the tab displays status, response
time, resolution time, source, reference number, and subject. You can open, copy, delete, print, forward, and
propose an incident as an answer from the Incidents tab. See Incident Creation.

Note:  If you change the incident’s contact to one that is not associated with the organization, the
incident will not appear on the tab.

• Hierarchy —Contains the hierarchical structure of the organization. See Organization Hierarchies.

• Aachments —Lists all aachments associated with the organization. The Aachments tab displays the
le name, size, date created, date updated, and a description for each aachment. See Overview of the
Aachments Tab.

• Audit Log —Lists all actions taken on the organization record by all sta members. Also displayed are
automatic changes initiated by Oracle Service Cloud that resulted from the application of business rules. When
an action is generated by the system, the Who eld contains Administrator. You can also see who worked on
the organization, when it was added or updated, the actions taken, and descriptions of the actions. See Audit
Logs.

Add an Organization  
You can add organizations independently of other records, or you can add them when you work on contacts.

Because other sta members may have permission to add organizations, the organization you plan to add may already
be in the knowledge base. To avoid duplicating organization records, search the knowledge base before adding an
organization to be sure it does not already exist. See Record Search Options.

1. Do one of the following:
◦ Click New.

◦ If your navigation set is congured to add organizations from the le menu, click File and select
Organization. See Congure the File Menu.

◦ Click Search next to the Organization eld from a contact record, and then click New Organization on
the Organization Search window.

A new organization opens on a subtab.
2. Enter eld information.

Field Description

*Organization Name Enter the name of the organization in this eld.

Billing Click Edit in the lower right corner of the eld to display a window for entering the
organization’s address. Enter information in the Street, City, and Postal Code elds, and
make selections on the Country and State/Prov. elds drop-down menus. When you
select the country, the associated states or provinces appear in the State/Prov. menu.
Press Enter when you are nished to close the window and display the address.
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Field Description

To select another address type, either Shipping or any custom address organization
type, click the arrow and select the address type. Then complete the address
information.
 

SLAs Click Add or Edit in this eld to open the SLA Viewer window and add or remove an SLA
instance for the organization. (If you have read-only permission in your prole, you will
only be able to view an SLA instance that has already been applied.) See SLA Instance
Field.
This eld applies only to Service.
 

*State Click this drop-down menu and select one or more of the following check boxes.

◦ Service

◦ Outreach

◦ Opportunities

The State eld classies how the organization was added (whether through Service
when working on an incident, Oracle RightNow Outreach Cloud Service (Outreach) when
adding contacts, or opportunity tracking when working on an opportunity). The State
eld may be updated automatically, and you can also update it manually.
 

Salesperson Click this drop-down menu to select a salesperson assigned to the organization. This
eld defaults to your name on the standard organization workspace. See Assign a
Record from a Report.

Login Enter a name in this eld to designate a login for members of the organization to use
when logging in to the customer portal. If your customer portal was congured to
require an organization login, customers must know the organization login name so
their contact record can be associated and authenticated with the organization.
This eld applies only to Service.
 

Password Enter a password in this eld to assign a login password to the organization.
This eld applies only to Service.
 

3. To add contacts to the organization, click the Contacts tab. See Add New Contacts to an Organization.
4. To associate the organization with a new opportunity, click the Opportunities tab, click Add New, and complete

the opportunity elds. See Overview of Opportunities.
5. To add notes to the organization record, click the Notes tab, click Add, and enter your comments in the eld.

Note:  Add notes to the organization when you want to provide information for other sta members.
Notes are not visible to customers. Click Note Channel (next to Organization Note on the subheading
of the Notes tab) to select the channel through which you gained the information you are adding to
the note. Besides selecting No Channel, options include Phone, Fax, Post, CSS Web, and Email.

6. To associate tasks with the organization, click the Tasks tab, where you can add, edit, print, copy, assign, delete,
and forward tasks associated with the organization and mark them complete. See Tasks Tab.

7. To associate the organization with a new incident, click the Incidents tab, click Add New, and complete the
incident elds. See Add an Incident.
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8. To dene the organization in terms of its parent or subsidiary divisions, click the Hierarchy tab. See
Organization Hierarchies.

9. To aach les to the organization record, click the Aachments tab. See Overview of the Aachments Tab.
10. To view the audit log for the organization, click the Audit Log tab. See Audit Logs.
11. To add a ag to the organization, click the area next to the white ag at the top of the content pane. See Add a

Flag to a Record.
12. If the organization you are adding is on a subtab (because you are adding the organization to a contact), click

OK.

Note:  Closing the new organization subtab saves the organization data in memory, but the
organization is not added to the knowledge base until you save the contact you added the
organization to.

13. Click Save.

Add New Contacts to an Organization  
You can add new or existing contacts to an organization. This procedure is for adding new contacts.

1. Right-click the organization you want to add contacts to and select Open.
On the standard organization workspace, the organization opens with the Contacts tab as the active record tab.

2. Click Add New on the Contacts tab.
A new contact opens on a subtab.

3. Enter the contact’s rst and last names in the appropriate elds.
4. Select one or more check boxes in the State drop-down menu.
5. To enter additional contact information, complete any of the remaining elds on any of the record tabs. See

Add a Contact.
6. Click OK.

Clicking OK on the new contact subtab closes the subtab and saves the contact information in memory, but the
contact is not added to the knowledge base until you save the organization.

7. To add more contacts to the organization, repeat the previous steps.
8. Click Save.

Add Existing Contacts to an Organization  
You can add new or existing contacts to an organization. This procedure is for adding existing contacts.

The existing contacts may or may not already be associated with an organization. All incidents for which the contact
was the primary contact are now associated with the organization you add the contact to. Opportunities for which
the contact is the primary contact do not change their organization association when you add the contact to the
organization. For more information about contacts, see Overview of Contacts.

1. Right-click the organization you want to add contacts to and select Open.
On the standard organization workspace, the organization opens with the Contacts tab as the active tab.

2. Click Add Existing.
The Contact Search window opens.

3. Enter an entry in any of the available elds: Contact Last Name, Contact First Name, Phone, Email, Postal
Code, or Organization.
You can use an asterisk (*) as a wildcard in your search term.
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4. Select one or more check boxes in the State drop-down menu.
5. Click Search.

The contacts that match the search criteria are returned on the Contact Search window.

Note:  When only one contact matches the search criteria, the Contact Search window closes and that
contact appears on the Contacts tab.

6. Select the contact you want to associate with the organization and click Select.
The window closes and the contact appears on the organization’s Contacts tab.

7. Click Save.

Edit an Organization  
You might need to view or update organization information.

Depending on the permissions set in your prole, you can view organization information, edit organizations, copy, print,
and delete organizations, and remove contacts from an organization.

1. Right-click the organization and select Open.
The organization record opens.

2. Make the necessary changes to any eld on any tab.
3. Click Save.

Delete an Organization  
This procedure describes how to delete an organization.

CAUTION:  Deleting organization records can aect other sta members within your organization. This action
permanently removes not only the organizations from the knowledge base, but also all contacts associated
with the organization and the incidents and opportunities for which the contacts are primary contacts. See
What Happens When You Delete a Contact.

1. Right-click the organization and select Delete.
A message asks you to conrm that you want to delete the organization.

2. Click Yes.

Remove Contacts from an Organization  
This procedure describes how to remove contacts from an organization.

1. Right-click the organization and select Open.
The standard organization workspace displays the organization record with the Contacts tab as the active tab.

2. In the list of contacts, right-click the one you want to remove from the organization and select Remove.
3. Click Yes on the message that conrms the removal of the contact.
4. To remove additional contacts, repeat these steps.
5. Click Save.

The contacts are removed from the organization but not from the knowledge base.
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Organization Hierarchies  
The Organization Hierarchy feature in Oracle Service Cloud enables you to create a hierarchy for any organization that
has subordinate organizations.

For example, if an organization in your knowledge base has several subsidiaries or regional or international oces,
each having an organization record in the knowledge base, you can add the subordinate organizations to the parent
organization, thereby creating an organization hierarchy. After you create a hierarchy for an organization, you can easily
add and remove organizations and change the order of the hierarchy structure.

An organization can have an unlimited number of subordinates, organized into a maximum of twelve levels per parent
organization.

CAUTION:  Changing an organization’s hierarchy can impact the incidents and opportunities associated with
all organizations in the hierarchy. Therefore, make sure you understand the consequences of changing the
structure of an organization’s hierarchy.

How You Work with the Hierarchy Tab  
On the Hierarchy tab, you can add a new or existing organization, open or print an organization, remove an organization
from the hierarchy, nd an organization in the hierarchy, and refresh to restore the hierarchy to its previously saved state
and discard your edits.

Buon Description

Add Click and select one of the following options.

Add New Select to open a new organization on a subtab and add an organization to the hierarchy.

Add Existing Select to open the Organization Search window and add an existing organization to the hierarchy.

Open Click to open the selected organization and edit it.

Print Click to print the selected organization.

Remove Click to remove the organization from the hierarchy.

CAUTION:  Removing an organization also removes its subordinate organizations from the
hierarchy.

Find Click to open the Find window and search the hierarchy for an organization.

Refresh Click to restore the organization hierarchy and discard any changes you have made.

CAUTION:  To delete an organization that is part of an organization hierarchy, rst remove the organization
from the hierarchy. Then delete the organization from the knowledge base. As always, use caution when
deleting organizations. See Delete an Organization.
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Add a New Organization to the Hierarchy  
This procedure describes how to add a new organization to the hierarchy.

1. Right-click the organization and select Open.
The content pane displays the organization record.

2. Click the Hierarchy tab.
3. Click  Add > Add New .

A new organization opens on a subtab.
4. Enter the organization name.
5. Select one or more check boxes in the State drop-down menu.
6. To enter additional organization information, complete any of the remaining elds on any of the record tabs.
7. Click OK to close the new organization subtab and add the organization to the hierarchy of the organization you

are editing.
8. To change the position of the organization you added, expand the hierarchy and drag and drop the

organization.
9. Click Save.

Related Topics
• Add an Organization

Add an Existing Organization to the Hierarchy  
This procedure describes how to add an existing organization to the hierarchy.

1. Right-click the organization and select Open.
The content pane displays the organization.

2. Click the Hierarchy tab.
3. Click Add and select Add Existing.

The Organization Search window opens.
4. Enter search criteria in the elds to lter your organization search and click Search.

The organizations that match your search criteria display.
5. Select an organization from the list and click Select.

a. To move only some of the selected organization’s subsidiaries to the organization hierarchy, clear the
check boxes for those you do not want to move.

b. Click OK to close the window and move the organization and selected subsidiaries to the hierarchy.
c. To view the full organization hierarchy, right-click any organization within the hierarchy and select

Expand All.
If the organization you select is not already part of a hierarchy, selecting it closes the Organization Search
window and adds the organization to the hierarchy of the original organization.

Note:  If the organization you are adding is part of another hierarchy, a message noties you that the
selected organization contains subsidiaries. Moving the organization also moves all its subsidiaries
unless you select to move only specic subsidiaries.

6. Click Save.
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Contacts  

Overview of Contacts  
Customer data is the foundation of Oracle Service Cloud. It includes basic information such as a customer’s name,
email address, and phone number as well as information about customer service issues, opportunities, and marketing
mailings opt-in status.

Every customer has a contact record in the knowledge base that contains information about the customer. But before
you can understand contacts, you must rst understand how contacts and organizations are associated and also how
contacts are associated with incidents and opportunities.

The contact information you add and edit becomes part of your organization’s knowledge base and is shared with all
sta members. If you are a sales representative, for example, you should know if a customer is having support issues
before you try to close a sale. If you are a service agent, you can beer help customers if you understand their past
support questions. And if you work in marketing, you must know whether the customer prefers plain text or HTML
email.

When customer information is kept up-to-date, the knowledge base provides complete information to your entire
organization. The results make your job easier and provide a superior customer experience.

Familiarize yourself with the following points before adding or editing contacts.

• An organization is any business entity that has an organization record in the knowledge base. For example,
organizations can refer to companies, divisions of companies, government agencies, educational institutions,
or nonprot associations.

• Contacts may or may not belong to an organization. If your customers are other organizations, you might have
several contacts associated with an organization record. If, on the other hand, your customers are individuals
rather than organizations, every contact record represents a unique customer. It is also possible that you have
both organizations and contacts as customers.

• Each contact is associated with only one organization, but an organization can have many contacts. Each
contact record displays all incidents, opportunities, tasks, surveys, marketing activity, aachments, and notes
for the contact, as well as the audit log, which displays all activity for the contact record.

• Every incident must have a primary contact. If your prole gives you the appropriate permissions, you
can change contact associations and delete contact records. Because these actions can have far-reaching
consequences on incidents as well as opportunities, it is important to understand what happens when you
make such changes.

Standard Contact Workspace  
Oracle Service Cloud provides a standard workspace for working with contacts.

The standard contact workspace denes which elds are available, what buons are displayed on the ribbon, and
how the information is organized on the content pane. Your organization may use the standard workspace, or your
administrator may have created one or more customized workspaces. Your prole denes the workspace you see when
you work with contacts, whether it is the standard workspace or a customized workspace. See Standard Workspaces or
Custom Workspaces.
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Contact Workspace Ribbon  
The buons on the standard contact workspace ribbon are used to perform actions on the workspace.

For more information about the ribbon in general and the Quick Access toolbar, see Common Functionality Ribbon.

Group/Buon Description

Editor

Undock Click to undock the contact editor from the console and display it in a separate window.

Save

Save Click to save the changes you have made to the contact and continue working. The contact record
remains open.
When you save a contact, the rules engine evaluates it. If contact rules exist and the contact matches
one or more rules, the record may be modied when you save it. For example, a rule can change a
contact’s state or set a custom eld value.
 

Save and Close Click to save the contact and close the record.

Actions
With the exception of the New and Appointment buons, the buons in this group are not enabled until after you have saved a contact you are
adding.
 

New Click to add a contact.

Refresh Click to refresh the current contact record.

Appointment Click to add an appointment that is associated with the contact. See Record Information Available in
Outlook Appointments.

Print Click to print the contact record.

Copy Click to copy the contact record.

Delete CAUTION:  To understand the consequences of this action before you delete a contact, see
What Happens When You Delete a Contact.

Click to delete the contact record.
 

Reset Password Click to invalidate the contact’s current password.
This action sends an email to the contact’s primary email address. Included in the email is a link to a
page where a new password can be set.
 

Proong

Spell Check Click to check the spelling of any elds that have spell checking enabled. See Spell Checking.

Links and Info

Links Click to select a URL from the list of links added by your administrator.
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Group/Buon Description

Info Click to see details about the contact, including when it was added and last updated and the record ID.
If the contact record is in a rules state, that information also appears.

Related Topics
• Common Functionality Ribbon

• Display Shortcut Keys on the Ribbon

Contact Workspace Record Tabs  
From an open contact record, you can view all opportunities, notes, tasks, incidents, surveys, marketing activity, and
aachments associated with the contact. You can also view the audit log, which lists all actions taken on the contact
record.

• Opportunities—Lists all opportunities associated with the contact. The tab contains the number of
opportunities associated with the contact in parentheses next to the tab name. For each opportunity, the tab
displays the opportunity name, the sta person it is assigned to, status, stage, the sales representative and
manager forecasts, and the date it was last updated. You can open, copy, delete, print, forward, and reject an
opportunity by clicking a buon on the tab’s toolbar or by right-clicking the opportunity and making your
selection. See Overview of Opportunities.

• Notes—Contains all notes associated with the contact. Notes can be viewed and selected by contact or
organization and sorted by date. Remember that customers never see the notes added by sta members. See
Add a Contact.

• Tasks—Lists all tasks associated with the contact. The tab contains the number of tasks associated with
the contact in parentheses next to the tab name. For each task, the tab displays the task name, due date,
completion date, the sta member assigned to the task, and priority. You can open, copy, delete, print, and
forward any task and mark tasks complete by clicking a buon on the tab’s toolbar or by right-clicking the task
and making your selection.

• Incidents—Lists all incidents associated with the contact. The tab contains the number of incidents associated
with the contact in parentheses next to the tab name. For each incident, the tab displays status, time beyond
the response threshold, time beyond the resolution threshold, source, reference number, and subject. You can
open, copy, delete, print, forward, and propose an incident as an answer by clicking a buon on the tab’s toolbar
or by right-clicking it and making your selection. See Incident Creation.

• Surveys—Contains all survey activity associated with the contact. The tab contains the number of surveys
associated with the contact in parentheses next to the tab name. For each survey, the tab displays when the
customer completed the survey, the survey score, and the type and name of the survey. The Action column
allows you to view the contact’s response. See Overview of Surveys.

• Outreach Activity—Contains all outreach activity associated with the contact, such as mailings that were viewed
or tracked links that were clicked. The Outreach Activity tab contains the number of mailings associated with
the contact in parentheses next to the tab name. The tab displays when the activity occurred, what the activity
was, a description of the activity, the name of the mailing, and any documents for each listed activity. See
Overview of Mailings.

• Aachments—Lists all aachments associated with the contact. The tab displays the le name, size, date
created, date updated, and a description for each aachment. See Overview of the Aachments Tab.

• Audit Log—Lists all actions taken on the contact record by you, other sta members, and the customer. It also
displays any automatic changes initiated by Oracle Service Cloud that resulted from the application of business
rules or through conguration seings. See Audit Logs.
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Note:  Your administrator may add additional tabs to a custom contact workspace assigned to your prole.
The Role Sets View control can be added to a custom contact workspace to dene Community Self Service roll
sets for the contact. See Overview of the Community Access Control.

Add a Contact  
Contacts can be added to the knowledge base by customers and sta members.

Because many sta members can have permission to add contacts, the contact you plan to add may already be in the
knowledge base. To avoid duplicating contact records, search the knowledge base before adding a contact to be sure it
does not already exist. See Record Search Options.

A customer can add a contact record when creating an account on the customer portal. Sta members can add contacts
using a contact workspace. They can also add them when working on incidents, opportunities, organizations, tasks,
assets, and contact lists.

1. Do one of the following:

◦ Click New on the ribbon.

◦ If your navigation set is congured to add contacts from the le menu, click File and select Contact. See
Congure the File Menu.

You can also add a contact while working on many types of open records, using one of the following methods:

◦ Right-click in the Contact eld of an open incident, opportunity, task, asset, or contact list, then select
Add New. The new contact opens on a subtab, which contains the same elds and tabs as the standard
contact workspace does.

◦ Use the Contacts tab of an open incident, opportunity, or organization record to add a new contact. See
How You Add Contacts from Other Records.

2. Enter eld information.

Field Description

*First Name Enter the contact’s rst name in this eld.

*Last Name Enter the contact’s last name in this eld.

Email Enter the contact’s email address in this eld. To add alternate email addresses, click the
arrow and select Email Alt 1 or Email Alt 2. Then enter the alternate email address in the
eld.
If you enter an email address that is already in the knowledge base, you will receive an
error message and not be able to save the contact. If email address sharing is enabled,
 meaning multiple contacts can share the same email address, a yellow icon with a black
exclamation point displays when you enter an email address that is associated with a
dierent contact in the system. If this icon appears, you can save the contact without
changing the contact’s email address. Email address sharing validation begins when
the Email address eld receives focus and ends when the eld loses focus. See Email
Address Sharing.
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Field Description

Oce Phone Enter the contact’s phone number in this eld. To add other phone numbers, click the
arrow, select one of the options, and enter the phone number in the eld. The options
include Mobile, Fax, Assistant, and Home.

Address Click Edit in the lower right corner of the eld to display a window for entering the
contact’s address. Enter information in the Street, City, and Postal Code elds, and make
selections on the Country and State/Prov. elds drop-down menus. When you select the
country, the associated states or provinces appear in the State/Prov. menu. Press Enter
when you are nished to close the window and display the address you entered.

Contact Type Click this drop-down menu and select a contact type. These options are unique to your
organization and were added by your administrator. See Add or Edit a Contact Type.

Channel Usernames Click Add in this eld to open the Channel Usernames window where you can add
Facebook, Twier, and YouTube user names for contacts. See Overview of Channels.
This eld does not display unless your administrator has congured a custom contact
workspace for the Channel Usernames eld. See Overview of Workspaces. In addition,
 contacts can provide their own Facebook, Twier, and YouTube user names through the
ChannelAllInput and ChannelAllDisplay widgets on the customer portal. See Customer
Portal Widgets.
 

*State Click this drop-down menu and select one or more of the following check boxes:
Service, Outreach, or Opportunities.
The State eld classies how the contact was added, whether through Oracle RightNow
Cloud Service (Service) when working on an incident, Oracle RightNow Outreach Cloud
Service (Outreach) when adding contacts, or opportunity tracking when working on an
opportunity, and what areas of Oracle Service Cloud the contact has since had activity
in. The State eld may be updated automatically, and you can also update it manually.
 

Organization Click Search to the right of the Organization eld to open the Organization Search
window and search for an organization to associate with the contact. See Associate a
Contact with an Organization.

Salesperson Click this drop-down menu and select the salesperson assigned to the contact. This eld
defaults to No Value. See Assign a Record from a Report.

Title Enter the contact’s title in this eld.

Login Enter a name in this eld to designate a login for the customer to use when logging in to
the customer portal. If the customer added the contact record on the customer portal,
 this eld displays the login the customer entered. This eld applies only to Service. A
login must be unique for each contact even if email address sharing is enabled. See
Email Address Sharing.
The login may not contain a space, single quote, double quote, less than, or greater
than character. We recommend that you use ASCII characters when creating a customer
login.
 

518



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Field Description

SLAs An SLA is a service level agreement. Click Add or Edit in this eld to add, edit, or remove
an SLA instance for the contact. (If you have read-only permission in your prole,
you will only be able to view an SLA instance that has already been applied.) See SLA
Instance Field.
This eld applies only to Service and only for contacts that do not have an organization
association. If the contact is associated with an organization, you must apply SLA
instances to the organization, not the contact.
 

Global Opt-in Click this drop-down menu and select Yes if the customer has opted to receive
marketing mailings and No if the customer does not want to receive them.

3. To associate the contact with a new opportunity, click the Opportunities tab. (This tab is on top by default on
the standard contact workspace.) Click Add New to open a new opportunity on a subtab, and then complete
the elds. See Overview of Opportunities.

4. To add notes to the contact record, click the Notes tab, click Add, and enter your comments in the eld.
Add notes to the contact when you want to provide information for other sta members. Notes are not visible
to customers. Click the Contact Note drop-down menu to select the channel through which you gained the
information you are adding to the note. Besides selecting No Channel, options include Phone, Fax, Post, CSS
Web, and Email.

5. To associate tasks with the contact, click the Tasks tab where you can add, open, print, copy, assign, delete, and
forward tasks associated with the contact and mark them complete. See Tasks Tab.

6. To associate the contact with a new incident, click the Incidents tab. Click Add New to open a new incident on a
subtab, and then complete the elds. See Add an Incident.

7. To view surveys the contact has participated in, click the Surveys tab.
8. To view mailings the contact has received, click the Outreach Activity tab.
9. To aach les to the contact record, click the Aachments tab. See Overview of the Aachments Tab.

10. To view the audit log for the contact record, click the Audit Log tab. See Audit Logs.
11. To add a ag to the contact, click the area next to the white ag at the top of the content pane. See Add a Flag

to a Record.
12. If the contact you are adding is on a subtab (because you are adding the contact to a contact list, incident,

opportunity, or task), click OK.

Note:  Closing the New Contact subtab saves the contact data in memory, but the contact record is not
added to the knowledge base until you save the record you have added the contact to.

13. Click Save.

Related Topics
• Record Search Options

How You Add Contacts from Other Records  
You can add or edit a contact from the Contacts tab when you work with incidents, opportunities, and organizations.

These options are also available by right-clicking any contact.
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Buon Description

Add New Click to add a new contact to the record. See Add a Contact.

Add Existing Click to search for and add an existing contact to the record. See Record Search Options.

Open Click to open the contact record. See Edit a Contact.

Print Click to print the contact record. See Print a Record.

Copy Click to copy the contact record. See Copy a Record.

Delete Click to delete the contact record. See What Happens When You Delete a Contact.

Remove Click to remove the contact association from the incident, opportunity, or organization.
 

Email Click to open your email client with an untitled message to the contact.
This buon is enabled only if your prole includes permission to email contacts.
 

Set Contact Role Click to assign a contact role to the contact. See Set a Contact Role.
This buon is available only when editing opportunities.
 

Options Click to display a drop-down menu of options that include actions you can take, such as printing,
forwarding, publishing, or exporting the contact data.

The following columns are available on the Contacts tab.

• Primary (for incidents and opportunities)

• Full Name

• Email Address

• Organization Name

• Oce Phone

• Title

• Contact Role (for opportunities)

• Action

The Action column contains Open, Delete (secondary contacts only for incidents), and Print options for the contact. You
can also access these options by right-clicking the contact. Other right-click options include Copy, Remove, Email, Set
Contact Role (opportunities only), and Copy Cell to Clipboard. (The right-click options are the same as those oered by
the buons on the Contacts tab toolbar.)

Related Topics
• Add a Contact

• Search for a Record from a Report

Contact Associations  
Changing a contact organization association has implications for the incidents and opportunities associated with the
contact.
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If you change the organization for a contact who is the primary contact for an incident, the incident’s organization
association changes to match that of the contact. Secondary contacts from a dierent organization remain with the
incident even when you change the organization association of the primary contact. The eect of changing a contact’s
organization association does not change the opportunity’s organization association. The contacts associated with the
opportunity remain the same, regardless of the organization they are associated with.

It is possible to add contacts and not associate them with any other type of record in the knowledge base. But the
real value of Oracle Service Cloud comes from being able to associate contact records with organizations, incidents,
opportunities, tasks, and contact lists. All sta members with permissions in their prole, whether they work in Service,
Opportunity Tracking, Outreach, or Oracle RightNow Feedback Cloud Service (Feedback), can open and update contact
records, ensuring that every sta member has the most current information about all contacts.

Associate a Contact with an Organization  
When you know that a contact you are adding belongs to an organization that is already in the knowledge base, you
should associate the contact with the organization.

If the organization is not yet in the knowledge base, you can enter organization information for the contact to create
an association between the two types of records. You can associate a contact with an organization at any time. For
example, you can associate a contact with an organization when you add the contact. Or you can edit the contact later
to add the organization association. The procedure for associating a contact with an organization is the same whether
or not the contact is currently associated with another organization.

Note:  If you change a contact’s organization association, you also change the organization association for all
incidents for which the contact is the primary contact. However, the organization association for the contact’s
opportunities do not change when you change the contact’s organization association.

1. Do one of the following:

◦ Right-click a contact on the content pane and select  Open > Contact . The contact record opens. If the
contact is associated with an organization, the organization name appears in the record.

◦ If your navigation set is congured to add contacts from the le menu, click File and select Contact. See
Congure the File Menu.

2. Click Search to the right of the Organization eld.
You can also click the link in the Organization eld, then select an organization from the list of recently viewed
organizations. See How You Search from Open Records.
The Organization Search window opens.

3. To search by organization name, enter the rst few characters in the Organization Name eld.
An implied wildcard is used so all organizations that begin with the leers you enter are returned.

4. To search by State, select any or all of the Select All, Service State, Outreach State, or Opportunities State
check boxes in the drop-down menu.

5. Click Search.
The list of organizations that match the search criteria appears.

6. Do one of the following:

◦ Select the organization you want to associate the contact with and click Select or press Enter. The
Organization Search window closes and the organization appears in the contact record.

◦ If the organization does not appear in the list, click New Organization to open a new organization on
a subtab and complete the elds. (The search term you entered in the Organization Name eld on the
search window appears in the Organization Name eld on the new organization subtab.) See Add an
Organization.

7. Click Save.
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How You Associate Contacts with Incidents  
When you work on an incident in Oracle RightNow Cloud Service (Service) and add a new or existing contact to the
incident, that contact-incident association is automatically created when you save the incident.

A contact-incident association is also created when you add an incident to a contact by clicking the Incidents tab and
clicking the Add New buon. See Add an Incident.

How You Associate Contacts with Opportunities  
When you work on an opportunity in Opportunity Tracking and add a new or existing contact to the opportunity, the
contact-opportunity association is automatically created when you save the opportunity.

A contact-opportunity association is also created when you add an opportunity to a contact by clicking the
Opportunities tab and clicking the Add New buon. See Overview of Opportunities.

Remove a Contact from a Record  
There might be times when you want to remove a contact from a record but do not want to delete the contact from the
knowledge base. In those instances, you can remove the contact from the incident, opportunity, organization, or contact
list.

To remove a contact from an open task, right-click the name in the Contact eld and select Clear.
1. Do one of the following:

◦ On the Contacts tab of the record, select the contact you want to remove and click Remove.

◦ Right-click the contact and select Remove.

A message asks you to conrm that you want to remove the contact.
2. Click Yes.

The contact remains in the knowledge base but is no longer associated with the record.
3. Click Save.

Edit a Contact  
It is highly likely you will encounter situations where you need to update contact information for contacts that are
already in the knowledge base.

This procedure assumes a contacts report is displayed on the content pane.

Depending on the permissions set in your prole, you can edit a contact record whenever you need to add or change
customer information. You can also copy, print, and delete contacts and set a contact role.

1. Right-click the contact and select  Open > Contact .
The contact record opens.

2. Make the necessary changes to any eld on any tab.
3. Click Save.
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What Happens When You Delete a Contact  
There are usually consequences when a contact is deleted. If the contact is associated with multiple incidents or
multiple opportunities or both, dierent results may occur with each record, depending on the type of associations and
the association of other contacts with the record.

In cases where the contact has multiple incidents and opportunities, follow the owchart for each record the contact is
associated with to discover what will happen to the record if you delete the contact.

For example, assume a contact is associated with two opportunities. Also assume that the rst opportunity does not
have an organization association while the second one does, and that neither opportunity has a secondary contact.
Deleting the contact removes the contact from the knowledge base and deletes the rst opportunity. The second
opportunity remains in the knowledge base, although the contact no longer appears on the Contacts tab.

Note:  When you delete secondary contacts for incidents and opportunities, the incidents and opportunities
are not deleted.
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Delete a Contact  
This procedure describes how to delete a contact.

CAUTION:  Deleting contact records can aect other sta members within your organization. This action
permanently removes not only the contacts from the knowledge base, but also all incidents for which the
contact is the primary contact. Opportunities can also be deleted, so you must understand the consequences
of deleting contacts before doing so. See What Happens When You Delete a Contact for specic results of
deleting contacts.

Sta members with the Bulk Delete permission enabled can delete up to 1000 contact records at a time. See
Administration Permissions and Bulk Delete. Transactions associated with those contacts are deleted asynchronously.
Purging transactions is controlled by data lifecycle management policies. See Data Lifecycle Management.

1. Right-click a contact and select Delete.
A message asks you to conrm that you want to delete the contact.

2. Click Yes.

Tip:  If you want to delete a contact but do not want to delete the incidents and opportunities
associated with that contact, you can specify dierent contacts for the incidents and opportunities
before you delete the original contact. See Reassociate the Contact with an Incident or Reassociate the
Contact with an Opportunity.

Set a Contact Role  
You can set a contact role from an opportunity.

1. Open an opportunities report.
2. Right-click an opportunity and select  Open > Opportunity .
3. Click the Contacts tab.
4. Right-click the contact and select Set Contact Role.

The Set Contact Role window opens.
5. Click the Contact Role drop-down menu and select a contact role for the opportunity contact.
6. Click OK.
7. Click Save.

Note:  The contact role may be dierent for dierent opportunities, which is why it is set from the
opportunity, not from the contact. For example, a contact might serve as a decision maker in one
opportunity and a referral in another.

Reassociate the Contact with an Incident  
Deleting a contact also deletes the incidents for which the contact is the primary contact. If the contact is associated
with incidents but is not the primary contact, those incidents will not be deleted.

If you do not want to delete the incidents for which the contact is the primary contact, you can reassociate the incidents
with a dierent contact before you delete the original contact.

1. Right-click the contact you want to delete and select  Open > Contact .
2. Click the Incidents tab.

The tab displays all incidents for which the contact is the primary.
3. Right-click the rst incident and select Open.
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The incident opens on a subtab.
4. Click the Contacts tab on the incident.
5. Click Add Existing.

The Contact Search window opens.
6. Search for a contact on the Contact Search window using the procedure described in Search for a Contact from

an Open Record.
The contact you select appears on the Contacts tab of the incident.

Note:  If a contact is added to an incident using the Search buon next to the Contact eld of the
incident, the existing primary contact is automatically removed from the incident and replaced with
the new primary contact. This logic also applies when clicking the contact’s name in the Contact eld
and selecting Change or Add New.If a contact is added to an incident using the Add New or Add
Existing functionality from the Contacts tab on the incident, the primary contact remains and the new
contact is added as a secondary contact.

7. Select the option under the Primary column for the contact you added.
This makes the new contact the primary contact for the incident.

8. Click OK to close the incident.
9. Repeat these steps for every incident you want to associate with a dierent contact.

10. Click Save.

The incidents you reassociated no longer appear on the Incidents tab of the contact. Now you can delete the contact
that was originally the primary contact. See What Happens When You Delete a Contact.

Reassociate the Contact with an Opportunity  
Clicking the Opportunities tab on an open contact displays the opportunities associated with the contact.

If no opportunities are listed, you can safely delete the contact without deleting any opportunities. If the contact is
associated with other opportunities but is not the primary contact, those opportunities will not be deleted when the
contact is deleted. If you want to delete the contact but not the opportunities associated with the contact, you can
reassociate the opportunities with a dierent contact.

1. Right-click the contact you want to delete and select  Open > Contact .
2. Click the Opportunities tab.

The tab displays all opportunities for which this contact is the primary contact.
3. Right-click the rst opportunity and select Open.

The opportunity opens on a subtab.
4. On the Contacts tab, click Add and select Add Existing.

The Contact Search window opens.
5. Search for a contact on the Contact Search window using the procedure described in Search for a Contact from

an Open Record.
The contact you select appears on the Contacts tab of the opportunity.

Note:  If a contact is added to an opportunity using the Search buon next to the Contact eld of the
opportunity, the existing primary contact is automatically removed from the opportunity and replaced
with the new primary contact. This logic also applies when clicking the contact name in the Contact
eld and selecting Change or Add New.If a contact is added to an opportunity using the Add New or
Add Existing functionality from the Contacts tab on the opportunity, the primary contact remains and
the new contact is added as a secondary contact.

6. Select the option under the Primary column for the contact you added.
This makes the new contact the primary contact for the opportunity.

7. Click OK.
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8. Repeat these steps for every opportunity you want to reassociate.
9. Click Save.

The opportunities you reassociated no longer appear on the Opportunities tab of the contact. Now you can delete the
contact that was originally the primary contact. If the contact you deleted belonged to an organization, the opportunity
remains with the organization, although the reassociated contact appears on the opportunity as well. See What
Happens When You Delete a Contact.

Email Address Sharing  
Email address sharing gives you the ability to associate a single email address with multiple contact records, which
allows a group of related contacts (such as a family or a team) to maintain individual contact records while sharing an
email address.

Note:  Contact records that share the same email address must have a unique login, or, for contacts without
a login, they must include a unique combination of rst name and last name, as duplicate contact records
cannot exist in the knowledge base. For example, Bill Short and Bill Short can share the same email address
as long as they have dierent logins.  If multiple contacts’ logins are left blank, their rst or last name must
be unique. In this case, Bill Short and William Short can share the same email address, since each name is
unique. Email addresses associated with a single contact record must be unique—that is, for a single contact,
the values of contacts.email, contacts.email_alt1, and contacts.email_alt2 cannot contain the same address.

After email address sharing is enabled, records and transactions initiated by a shared email address are associated with
the contact considered to be the best t. The contact-matching process used to determine the best t is shown in this
owchart.
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When shared contact addresses are in dierent elds (for example, contacts.email_alt1 and contacts.email_alt2), the
system selects the contact whose address is in the eld of highest precedence (contacts.email_alt1). However, if the
shared addresses are in the same eld (for example, both are in contacts.email_alt1), the system aempts to match
the values in the First Name and Last Name elds if available. If no match is found based on eld precedence or name
values, the system selects the contact record last updated in the database.

Areas Aected by Email Address Sharing  
The contact-matching process applies to areas of the product suite that associate contacts by email address, including
chats, mailings, surveys, web forms, site feedback, email transactions, and Create an Account and Ask a Question
requests on the customer portal.

Contact-matching logic is used only in cases in which the contact is not explicitly identied by a cookie. These areas in
Oracle Service Cloud are aected when email address sharing is enabled.

Area in Oracle Service Cloud Where to Find Information

Common
 

Email management
 

See How Email Works in Service or Email Bounce Handling.
 

Data import
 

See How Data Import Works.
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Area in Oracle Service Cloud Where to Find Information

Contact workspaces
 

See Add a Contact.
 

Outlook integration
 

See Email Address Sharing or Email Integration.
 

Service
 

Customer Portal
 

See Conguring Oracle Service Cloud for Customer Portal.
 

Oracle RightNow Chat Cloud Service (Chat)
 

See Chat for Agents, Supervisors, and Customers.
 

Outreach
 

Mailings
 

When dening an audience for broadcast and transactional mailings, you can allow delivery of
messages to multiple contacts who share the same email address. Audience count and web form
identication are also aected when email address sharing is enabled. See the following links:
 
Broadcast mailings—Create a Broadcast Mailing to view the option for the delivery of messages to
multiple contacts that are sharing the same email address.
 
Transactional mailings—Create a Transactional Mailing to view the option for delivery of messages to
multiple contacts that are sharing the same email address.
 
Audience count—View Audience Count Details in Mailings to view the description of the Duplicate
Email column on the Audience Count Details window.
 
Web form identication— Insert a Web Form.
 

Feedback
 

Surveys
 

When dening an audience for broadcast and transactional surveys, you can allow delivery of
messages to multiple contacts who share the same email address. Audience count and web form
identication are also aected when email address sharing is enabled. See the following links:
 
Broadcast surveys—Create a Broadcast Survey to view the option for the delivery of messages to
multiple contacts that are sharing the same email address.
 
Transactional surveys—Create a Transactional Survey to view the option for the delivery of messages
to multiple contacts that are sharing the same email address.
 
Audience count—View Audience Count Details in Surveys to view the description of the Duplicate Email
column on the Audience Count Details window.
 
Web form identication— Insert a Web Form.
 

Enable Email Address Sharing  
To make email address sharing available, it must rst be enabled.
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CAUTION:  Enabling email address sharing removes important safeguards that prevent the creation of
duplicate contacts and protect your reputation for sending mailings and surveys. Also, disabling email address
sharing after it has been enabled can cause conicts when duplicate email addresses are encountered. For
these reasons, email address sharing is disabled by default and we recommend it be enabled only if it is
required for your business processes and only after thorough consideration has been given to the potential
impact.

1. Click Conguration on the navigation pane.
2. Click Database, then double-click Email Address Sharing.

The Email Address Sharing editor displays on the content pane.
3. Select Enabled.
4. Click Save.

A message warns you that duplicate email address safeguards will be removed.
5. Click OK.

After email address sharing is enabled, sta members who are currently logged in to Oracle Service Cloud must log out
and log back in for the change to take eect.

Contact Synchronization with Oracle Commerce Service Center
Integration  
Contacts are synchronized between Oracle Commerce Service Center (CSC) and Oracle Service Cloud, leing you view
CSC contact information and order details on the Service Console.

From there, you can take action on an existing CSC order or place a new order in CSC on behalf of the customer. CSC
must be enabled. Contact your Oracle account manager. See Oracle Commerce Service Center for more information on
working with CSC on the Service Console.

Tasks  

Overview of Tasks  
With task functionality, you can add tasks to records you are working on.

In addition, you can add standalone tasks that are not related to specic records. By keeping track of all tasks in Oracle
Service Cloud, you can monitor everything you must do from a single location, all but eliminating the possibility of
forgeing a critical task. You can add tasks from the le menu or the Tasks tab on records. By familiarizing yourself with
the standard workspace for tasks, you will know how to add and edit tasks during your workday.

Standard Task Workspace  
Oracle Service Cloud provides a standard workspace for working with tasks.

The standard task workspace denes which elds are available, what buons are displayed on the ribbon, and how the
information is organized on the content pane. Your organization may use the standard workspace, or your administrator
may have created one or more customized workspaces. Your prole denes the workspace you see when you work
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with contacts, whether it is the standard workspace or a customized workspace. See Standard Workspaces or Custom
Workspaces.

Task Workspace Ribbon  
The buons on the standard task workspace ribbon are used to perform actions on the workspace.

Buon Description

Undock Click to undock the task workspace editor from the console and display it in a separate window.

Save Click to save the task and keep it open for editing.
When you save a task, the rules engine evaluates it. If task rules exist and the task matches one or
more rules, the task may be modied when you save it. For example, a rule can change a task’s status
or assign it to a dierent sta member.
 

Save and Close Click to save the task and close it.

New Click to add a task.

Refresh Click to refresh the current tasks report.

Forward Click to forward the task. See Forward a Record.

Print Click to print the task. See Print a Record.

Copy Click to create a copy of the task that you can modify to create another task.

Delete Click to delete the task.
 

CAUTION:  This action cannot be undone.

Spell Check Click to check the spelling of any task elds that have spell checking enabled. See Check Spelling
Manually.

Links Click to select a URL from the list of links added by your administrator. See Overview of Workspace and
Script Elements.

Info Click to display information about the open task, including the task ID, the dates the task was added,
 last updated, and completed, its escalation level, and any rule state it might be in.

Related Topics
• Common Functionality Ribbon

• Display Shortcut Keys on the Ribbon

Task Workspace Record Tabs  
The standard workspace for tasks includes these tabs.

• Summary—Contains all key elds for the task. You can also select a record with which you want to associate the
task. Depending on the height of the Service Console on your screen, the key elds might be displayed on the
content pane, rather than on a separate Summary tab.
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• Aachments—Contains the aachments associated with the task. The tab displays the le name, size, date
created, date updated, and a description for each aachment.

• Audit Log—Lists the actions taken on the task, including the time the action was taken, who carried out the
action, what the action was, and a description of the action.

• Notes—Contains task notes that can be sorted by date. Remember that customers never see the task notes
added by sta members.

Related Topics
• Overview of the Aachments Tab

• Audit Logs

• Add a Task

Tasks Tab  
Besides adding and editing tasks on the task workspace, you can add or edit them from the Tasks tab when you are
working on an answer, campaign, contact, document, incident, mailing, opportunity, organization, or survey.

These options are also available by right-clicking a task.

Buon Description

Add New Click to open a new task on a subtab.

Add Existing Click to display the Task Search window. After nding and selecting a task, the task is added to the task
list for the record.

Open Click to open the selected task for editing.

Print Click to print the task.

Copy Click to copy the task.

Delete Click to delete the task.

Remove Click to remove the task association.
The task is disassociated, but the task record remains in the knowledge base.
 

Complete
 

Click to mark the task complete.

Forward Click to forward the task to the selected recipients.

Options Click to display a drop-down menu of options that include actions you can take, such as printing,
previewing, forwarding, publishing, or exporting the task data.

Related Topics
• Add a Task

• Edit a Task

• Complete a Task

• Search for a Task from an Open Record

• Forward a Record
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Delete a Task  
Deleting a task removes it permanently from the knowledge base.

When you delete answers, campaigns, contacts, documents, incidents, mailings, opportunities, organizations, or
surveys that have associated tasks, any tasks associated with the records are also deleted. The type of record that a task
is associated with is determined by the value of the Task Type eld.

1. Open a task report.
2. Do one of the following:

◦ Right-click on a task and select  Delete > Task .

◦ Open a task and click Delete.

The Task Delete conrmation window displays.
3. Click Yes.

Related Topics
• Overview of Tasks

Complete a Task  
You can change the status of a task to Complete.

1. Open a task report.
2. Select one or more tasks to complete.

To select multiple tasks, press Ctrl while selecting tasks.
3. Right-click on the selected task(s) and select Complete Task.

You can also select a single task and click Complete in the Action column to complete it. You cannot complete
multiple tasks this way.

Add a Task  
You can add a standalone task to serve as a reminder to yourself, or you can add a task to a specic record when you are
working on the record.

When you add a task, you dene its name, the sta member it is assigned to, relevant dates, and other task information.
You can also associate it with existing records. When you add a task in a workgroup, clicking the OK buon accepts
changes made to the record and closes the subtab. However, it does not save changes to the database until you click
Save or Save and Close.

1. Do one of the following:

◦ Click New.

◦ If your navigation set is congured to add tasks from the le menu, click File and select Task.

◦ If you want to add a new task from an open record (such as an incident) or from items like mailings and
campaigns, click Add New.

The new task opens in a separate window.
2. Enter eld information.

Field Description

*Name Enter the name of the task.
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Field Description

Assigned This eld defaults to your name in the standard tasks workspace, but you can click the
drop-down menu to assign the task to a dierent sta member if you have permission.

*Status Click this drop-down menu and select a status. The status options include Not Started,
 In Progress, Completed, Waiting, and Deferred.

Percent Complete Enter a value for the percentage of the task that is complete.

Priority Click this drop-down menu and select Low, Normal, or High as the task’s priority.

Due Date Click this drop-down menu to open the current month’s calendar and select the date the
task is due. Use the arrows at the top to change the month if necessary.

Planned Completion Click this drop-down menu to open the current month’s calendar and select the task’s
planned completion date.

Date Completed Click this drop-down menu to open the current month’s calendar and select a
completion date for the task.

Task Type Click this drop-down menu to select a task type. When you select a task type, the
associated record on the right side of the content pane is highlighted to indicate that it
is a required eld. In other words, if you dene a task as having an Opportunities task
type, you must select an opportunity for the task.
You do not have to select a task type if you do not want to associate the task with a
specic record.
 
If you are adding the task from an open record, the task type selection defaults to the
type of record being edited.
 

Notes Enter any notes about the task in this eld.

3. To associate the task with a record:
a. Click Search to the right of the record eld.
b. Enter information in the search elds.
c. Select the record you want to associate with the task.

If you have selected a task type, you must make a selection for the associated record (opportunity, organization,
contact, incident, answer, campaign, mailing, survey, or document).

4. To aach les to the task, click the Aachments tab.
5. To view the audit log for the task, click the Audit Log tab.
6. To add notes to the task:

a. Click the Notes tab.
b. Click Add.
c. Enter your comments in the eld.
d. Click the Task Note drop-down menu to select the channel through which you gained the information

you are adding to the note.
Add notes to the task when you want to provide information for other sta members. Notes are not visible to
customers.

7. Click Save.
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If you added the task on a subtab of a workgroup, all records in the workgroup will be saved.

Related Topics
• Overview of Tasks

• Record Search Options

• How You Inherit Task Fields

• Overview of the Aachments Tab

• Audit Logs

• Congure the File Menu

Edit a Task  
Depending on the permissions set in your prole, you can edit, copy, and delete individual and multiple tasks, forward
tasks, and mark them complete.

A task report is displayed on the content pane.
1. Right-click the task you want to edit.
2. Click  Open > Task

The task opens.
3. Make the necessary changes.
4. Click Save.

Related Topics
• Overview of Tasks

• How You Update Multiple Records

How You Inherit Task Fields  
When a task is associated with a record, some values for that task can be “inherited” from the associated record.

For example, you might add a task and dene it as an opportunity task by seing the Task Type eld to Opportunities.
After you have selected the opportunity you want to associate with the task, you can choose to set the assigned sta
member, organization, and contact for the task to the same ones that are associated with the opportunity. Then, if you
should later change the opportunity’s assigned sta member, organization, or contact, the same change will occur on
the associated task.

The concept of inheritance hinges on the task type. If you do not select an option from the Task Type drop-down menu,
the task eld values cannot be inherited from a record associated with the task. For instance, you can use the Inherit
property to make the task’s assigned sta member, organization, and contact the same as the opportunity’s values. If,
however, you leave the task type unspecied, you cannot use the Inherit property for those elds.

All of the task types—opportunities, organizations, contacts, incidents, answers, campaigns, mailings, surveys, and
documents—allow the Assigned eld to be inherited from the associated record. Use the Inherit property when you
want the task to always be assigned to the sta member who is assigned to the record, even when the sta member
assigned to the record changes. If you want a particular sta member to be assigned to the task, regardless of who is
assigned to the actual record, do not use Inherit.

For example, assume you set the Assigned eld of a Mailings task to Inherit. If you change the sta member assigned
to the mailing, the sta member assigned to the associated task also changes to the new sta member. If you want
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the task to always be assigned to the same person assigned to the mailing, even if that sta member changes, select
Inherit. If, on the other hand, you want a particular sta member to be assigned to the mailing task, regardless of who is
assigned to the actual mailing, do not use Inherit.

Related Topics
• Inherit Contact and Organization Fields

• Inherit the Assigned Field

Inherit Contact and Organization Fields  
With certain task types, you can set the organization eld, the contact eld, or both to inherit those eld values from the
associated record.

When you add or edit an opportunity or incident task type, you can set the organization and contact elds to
inherit those elds from the opportunity or incident. And when you add or edit a contact task type, you can set the
organization eld to inherit the organization associated with the contact.

When the task contact, organization, or both are tied to the associated record through the Inherit property, you can
ensure that the elds are the same for both the task and the record. An additional benet is the simplicity of completing
those task elds.

This procedure sets contact and organization elds to Inherit for an incidents task type. The procedure is the same for
opportunity and contact task types.

1. Open a task.
2. Click the Task Type drop-down menu and select Incidents.

The Incident eld label turns red and includes an asterisk, indicating that it is now a required eld, and an
Inherit buon appears to the right of the Organization and Contact elds.

3. Select the incident you want to associate with the task.
4. Click Search for the Incident eld.
5. Enter your search criteria in the search elds.
6. Click Search.
7. Select the incident you want from the list of search results.
8. Click Select.

The Incident Search window closes and the incident appears in the Incident eld of the task. If only one
incident matches the search criteria, the Incident eld is automatically populated.

9. Click Inherit to the right of the Contact eld.
The Inherit buon changes to Contact Locked (with a lock symbol) indicating the Inherit property is active, the
value in the Contact eld changes to the contact for the incident, and the eld is disabled and appears grayed
out.

10. Click Inherit to the right of the Organization eld.

The Inherit buon changes to Organization Locked (with a lock symbol) indicating the Inherit property is active,
the value in the Organization eld changes to the organization for the incident, and the eld is disabled and
appears grayed out.

If the incident does not have an organization, the eld is locked anyway. If you later add an organization to the
incident, the task Organization eld contains the same organization value as the incident.

11. To unlock the inheritance, click Locked to the right of the Contact or Organization eld.
The value in the eld remains the same, but the eld is enabled and you can change the value now that the
Inherit property is no longer active.
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Related Topics
• How You Inherit Task Fields

• Inherit the Assigned Field

Inherit the Assigned Field  
This procedure uses the Answer task type as an example, but the procedure is the same for all task types.

1. Open a task.
2. Click the Task Type drop-down menu and select Answers.

The Answer eld label turns red and includes an asterisk, indicating that it is now a required eld, and an Inherit
buon appears to the right of the Assigned eld.

3. Select the answer you want to associate with the task.
a. Click Search to the right of the Answer eld.
b. Enter information in the Search eld.
c. Choose the desired answer from the results list and click Select.

The Answer Search window closes and the answer appears in the Answer eld of the task. If only one
answer matches the search criteria, the Answer eld is automatically populated.

4. Click Inherit to the right of the Assigned eld.
The Inherit buon changes to Assigned Locked (with a lock symbol) indicating the Inherit property is active, the
value in the Assigned eld changes to the sta member assigned to the answer, and the eld is disabled and
appears grayed out.

5. To unlock the inheritance, click Locked to the right of the assigned eld.
The sta member name in the eld remains the same, but the eld is enabled and you can change the value
now that the Inherit property is no longer active.

Related Topics
• How You Inherit Task Fields

• Inherit Contact and Organization Fields

Outlook Integration  

Overview of Outlook Integration  
Microsoft Outlook can be integrated with Oracle Service Cloud, enabling you to share your contacts and tasks and
synchronize your email.

Using Outlook integration, your data will be more complete and up-to-date, and you’ll no longer need to switch back
and forth between applications. You can also create contacts and incidents when syncing Outlook email with Oracle
Service Cloud.

Outlook integration comprises the following components:

• Contact synchronization—Enter contact information one time, in either Oracle Service Cloud or Outlook, and
have that information shared in both applications.
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• Task synchronization—Enter task information one time in either application and have that information shared
in both applications.

• Email integration—Append Outlook email, including aachments, to existing contacts, organizations,
opportunities, and incidents in Oracle Service Cloud.

Besides synchronizing contacts, tasks, and email between Outlook and Oracle Service Cloud, you can also implement a
Microsoft smart tag in Outlook to open incidents directly from an email.

How You Congure Outlook Integration  
You must complete a few actions to use Outlook integration.

• Enable Outlook integration. Contact your Oracle account manager.

• Add or update proles to include Outlook integration permission. See Add Outlook Integration Permissions to a
Prole.

• Install Outlook integration software on agent workstations. See Install Outlook Integration.

Add Outlook Integration Permissions to a Prole  
You can be assigned full Outlook integration permissions (contact synchronization, task synchronization, and email
integration) or any combination of the three permissions.

Updating your prole is a necessary rst step as Oracle Service Cloud will check your permissions before installing the
appropriate Outlook integration components. All sta members who will be using Outlook integration must have the
prole containing Outlook integration permissions assigned to their sta account.

Sta members who are using Outlook 2007 must enable smart tags through  Tools > Options > Mail Format > Editor
Options > Proong > AutoCorrect Options > Smart Tags . Sta members who are using Outlook 2010 or 2013 must
enable smart tags through  File > Options > Mail > Editor Options > Proong > AutoCorrect Options > Actions .

1. Click Conguration on the navigation pane.
2. Expand Sta Management and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to edit.

The Proles editor opens.
4. Click Permissions on the ribbon.

The Permissions page opens.
5. Click the Outlook Integration tab.
6. To select all of the check box options on the Outlook Integration tab, select the Select All check box.
7. To let sta members append Outlook email to contacts, organizations, opportunities, and incidents in Oracle

Service Cloud, select the Email Integration check box.
8. To let sta members share contacts between Outlook and Oracle Service Cloud, select one or more of the

Contact Synchronization check boxes.
◦ To share contacts that are in the Opportunities state, select the Opportunities Contacts check box.

◦ To share contacts that are in the Service state, select the Service Contacts check box.

◦ To share Outlook contacts with Oracle Service Cloud, select the Outlook to Server check box.

◦ To share Oracle Service Cloud contacts with Outlook, select the Server to Outlook check box.

9. To let sta members share tasks between Outlook and Oracle Service Cloud, select one or both of the Task
Synchronization check boxes.
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◦ To share Oracle Service Cloud tasks with Outlook, select the Server to Outlook check box.

◦ To share Outlook tasks with Oracle Service Cloud, select the Outlook to Server check box.

10. To select dierent email synchronization reports for determining the contacts, opportunities, and incidents to
return during email synchronizations, click the Search buon to the right of the report you want to change.

a. After selecting a new report, click OK to close the Select Report window.
All of the Outlook integration reports are read-only standard reports that can be copied and modied.

11. Click Save.

Related Topics
• Proles

• Add or Edit a Sta Account

Install Outlook Integration  
After Outlook integration has been enabled and you have been assigned the correct prole permissions, you must
install the necessary components on your workstation.

When you install Outlook integration, Oracle Service Cloud checks your prole to see which components (email, contact,
and task) you have permission to share and synchronize. The installation process adds Share and Sync buons to your
Outlook toolbar.

1. Close Outlook.
2. From Oracle Service Cloud, click File and select  Links > Install Outlook Integration .

The Oracle Service Cloud Outlook Sync Setup wizard opens.
3. Click Next to open the Select Installation Folder window.

Tip:  We recommend that you install Outlook integration in the default location of C:/Program Files/
Oracle Service Cloud Outlook Sync.

4. To install Outlook integration in a dierent location, click Browse, select the folder where you want to install
Outlook integration, and click OK.

5. To see a list of the drives where Outlook integration can be installed, click Disk Cost. Click OK when you are
nished.

6. Do one of the following:

◦ If you are the only sta member who uses your workstation, select the Just Me option.

◦ If other sta members have accounts on your workstation and must also use Outlook integration, select
the Everyone option.

7. Click Next to open the Conrm Installation window.
8. Click Next to begin the installation.

After the installation is complete, the Installation Complete window opens.
9. Click Close to complete the installation.

With the proper components installed, you’ll want to review and possibly customize your sync options before using
Outlook integration.

Related Topics
• Contact, Task, and Email Sync Options

• Add Outlook Integration Permissions to a Prole
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Contact, Task, and Email Sync Options  
Outlook integration contains default synchronization options, but you can make any necessary changes to the defaults.

To start with, you’ll enter server details and your Oracle Service Cloud user name and password. You can then customize
contact and task sync options, including preferences for sync direction (such as from Oracle Service Cloud to Outlook,
but not vice versa) and the types of actions that can initiate synchronization. For email integration, you can choose
which types of records (contact, organization, incident, and opportunity) you want Outlook email appended to. (Email
integration occurs only from Outlook to Oracle Service Cloud.)

Note:  You must have administrative permissions on your workstation to change sync options. If you do not
have administrative permissions, contact your administrator.

Sync Seings Options  
Enter server details and your Oracle Service Cloud user name and password to let you change default sync options.

1. Open Outlook.
2. Click the arrow next to the Sync Email buon and select Sync Seings.

The Sync Seings window opens.
3. Enter eld information.

Field Description

Server Information
 

This section contains elds for entering server information. Contact your administrator
for information.
 
These elds may already be populated with your server and interface names.
 

Server Name
 

Enter the server name of the Oracle Service Cloud application.
 

Interface Name
 

Enter the interface name.
 

Use Secure Connection
 

Select this check box to use a secure connection between Outlook and Oracle Service
Cloud.
 

User Information
 

This section contains elds for entering your Oracle Service Cloud user information.
 

User Name
 

Enter your Oracle Service Cloud user name.
 

Password
 

Enter your Oracle Service Cloud password.
 

4. Click OK to save your seings and close the Sync Seings window.
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Contact Sync Options  
Select contact sync options for Outlook integration.

1. Open Outlook.
2. Click the arrow next to the Sync Email buon and select Sync Seings.

The Sync Seings window opens.
3. Click the Sync Contact tab.

4. Select options.

Field Description

Sync Direction This section contains check boxes for selecting the direction for contact
synchronization.
 
Selecting only one of the contact synchronization seings results in a one-way
synchronization.
 

From Oracle Service Cloud to
Outlook

Select to sync contact data from Oracle Service Cloud to Outlook. Contacts in Oracle
Service Cloud are added to the Contacts folder in Outlook only if one or more of the
following conditions are met:

◦ The contact is associated with an incident or opportunity that is assigned to you.

◦ The Salesperson eld on the contact’s record displays your name.

◦ The Salesperson eld on the contact’s organization record displays your name.

 

From Outlook to Oracle Service
Cloud

Select to sync contact data from Outlook to Oracle Service Cloud.
 

Auto Sync Events This section contains options for selecting when you want to sync contact data.
 

Aempt Sync When Saved Select to sync contact data between Oracle Service Cloud and Outlook when a contact is
saved in Outlook.
 

Aempt Sync When Open Select to sync contact data between Oracle Service Cloud and Outlook when a contact is
opened in Outlook.
 

Sync On Demand Only Select to sync contact data between Oracle Service Cloud and Outlook when you click
Share or Sync All Contacts on the Outlook toolbar. This option is selected by default.
 

If both the From Oracle Service Cloud to Outlook and From Outlook to Oracle Service Cloud check boxes are
selected, a two-way contact synchronization occurs. If the same data you are updating in Outlook has been
updated by another sta member working in Oracle Service Cloud, the data from Oracle Service Cloud will be
used during the two-way synchronization.
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Note:  When a contact record is rst created in Oracle Service Cloud as a result of a sync, the
Salesperson eld in the contact record is assigned to the sta member who performed the sync.
Subsequent synchronizations do not aect this eld. You can, however, manually update the
Salesperson eld by editing the contact record in Oracle Service Cloud.

5. Click OK to save the sync contact seings and close the Sync Seings window.

Task Sync Options  
Select task sync options for Outlook integration.

1. Open Outlook.
2. Click the arrow next to the Sync Email buon and select Sync Seings.

The Sync Seings window opens.
3. Click the Sync Task tab.
4. Select options.

Field Description

Sync Direction
 

This section contains check boxes for selecting task synchronization seings.
 
Selecting only one of the task synchronization seings results in a one-way
synchronization.
 

From Oracle Service Cloud to
Outlook
 

Select to sync task data from Oracle Service Cloud to Outlook.
 

From Outlook to Oracle Service
Cloud
 

Select to sync task data from Outlook to Oracle Service Cloud.
 

Auto Sync Events
 

This section contains options for selecting when you want to sync tasks.
 

Aempt Sync When Saved
 

Select to sync task data between Oracle Service Cloud and Outlook when a task is saved
in Outlook.
 

Aempt Sync When Open
 

Select to sync task data between Oracle Service Cloud and Outlook when a task is
opened in Outlook.
 

Sync On Demand Only
 

Select to sync task data between Oracle Service Cloud and Outlook only when you click
Share or Sync All Tasks on the Outlook toolbar. This option is selected by default.
 

Note:  If both the From Oracle Service Cloud to Outlook and From Outlook to Oracle Service Cloud
check boxes are selected, a two-way task synchronization occurs. If the same data you are updating
in Outlook has been updated by another sta member working in Oracle Service Cloud, the data from
Oracle Service Cloud will be used during the two-way synchronization.
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5. Click OK to save the task sync seings and close the Sync Seings window.

Email Sync Options  
Select email sync options for Outlook integration.

1. Open Outlook.
2. Click the arrow next to the Sync Email buon and select Sync Seings.

The Sync Seings window opens.
3. Click the Sync Email tab.
4. Select options.

Field Description

Allowed Record Types for Email
Sync
 

This section contains check boxes for selecting the types of records that are allowed for
email synchronization. All check boxes are selected by default.
 
Email is always synchronized one way from Outlook to Oracle Service Cloud.
 

Organization
 

Select to append email data from Outlook to the Oracle Service Cloud organization
record associated with the contact that has the same email address as the selected
email.
 

Contact
 

Select to append email data from Outlook to the Oracle Service Cloud contact record
with the same address as the selected email.
 

Opportunity
 

Select to append email data from Outlook to one or more opportunities in Oracle
Service Cloud for the contact associated with the email address.
 

Incident
 

Select to append email data from Outlook to one or more incidents in Oracle Service
Cloud for the contact associated with the email address. Then select one of the
following options to designate how the email should be appended to records in Oracle
Service Cloud: Customer Entry, Response, or Private Note.
 
The Customer Entry option is selected by default.
 

Auto Sync Events
 

This section contains options for selecting when you want to sync email.
 

Aempt Sync When Saved
 

Select to append email data from Outlook to Oracle Service Cloud when an email is
saved in Outlook.
 

Aempt Sync When Open
 

Select to append email data from Outlook to Oracle Service Cloud when an email is
opened in Outlook.
 

Sync On Demand Only
 

Select to append email data from Outlook to Oracle Service Cloud only when Sync Email
on the Outlook toolbar is clicked. This option is selected by default.
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Field Description

 

5. Click OK to save the email sync seings and close the Sync Seings window.

How You Synchronize Contacts  
While viewing or editing a contact in Outlook, you can click a buon to share the contact between Outlook and Oracle
Service Cloud.

If two-way synchronization is set up and you click Sync All Contacts, all your Outlook contacts are added to Oracle
Service Cloud. Before you can add Oracle Service Cloud contacts to the Outlook Contacts folder, your sta account must
be associated with the contacts. At least one of the following conditions must be true for each contact that you want to
add.

• The contact is associated with an incident or opportunity that is assigned to you.

• The Salesperson eld on the contact’s record displays your name.

• The Salesperson eld on the contact’s organization record displays your name.

Note:  When email address sharing is enabled in Oracle Service Cloud, which is the ability for more than one
contact to have the same email address, duplicate email addresses are detected when performing contact
synchronizations between Oracle Service Cloud and Microsoft Outlook. See Email Address Sharing.

After contact integration is set up on your workstation and the Contacts folder is selected, your Outlook toolbar
contains these buons.

Buon Description

  Click to sync the selected contact between Outlook and Oracle Service Cloud.
 

  Click this drop-down menu to display contact sync options.
 

Sync All Contacts
 

Select to sync all contacts between Outlook and Oracle Service Cloud.
 

Sync Seings
 

Select for sync options.
 

Related Topics
• Contact Sync Options
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Sync a Contact Between Outlook and Oracle Service Cloud  
Sync a contact between Outlook and Oracle Service Cloud.

1. From Outlook, click on the contact you want to sync.
2. Click Sync Contact.

If you have not previously shared Outlook data, you must enter your Oracle Service Cloud user name and
password to verify your permission before continuing.
A message lets you know that the contact was synchronized successfully.

3. Click OK.

Oracle Service Cloud now contains a contact record associated with the contact you shared.

Sync All Contacts Between Outlook and Oracle Service Cloud  
Sync all contacts between Outlook and Oracle Service Cloud.

1. From Outlook, click Sync All Contacts.
A Synchronization Succeeded message lets you know that the contacts were synchronized successfully.

2. Click OK.
The Sync All Contacts window opens, conrming the number of contact records that were synchronized
between Outlook and Oracle Service Cloud.

Tip:  To view details about the individual contacts that were synchronized, click the plus sign next to
the group of contacts you want to view.

3. Click OK.

How You Synchronize Tasks  
While viewing or editing a task in Outlook, you can click a buon and share the selected task or all your tasks with
Oracle Service Cloud.

If two-way synchronization is set up and you click Sync All Tasks, all your Outlook tasks are added to Oracle Service
Cloud, and all your Oracle Service Cloud tasks are added to the Outlook Tasks folder.

After task integration is set up on your workstation and the Tasks folder is selected, your Outlook toolbar contains these
buons.

Buon Description

 

Select a task from the list and click this buon to sync the selected task between Outlook and Oracle
Service Cloud.
 

 

Click this drop-down menu to display task sync options.
 

Sync All Tasks Select to share all tasks between Outlook and Oracle Service Cloud.
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Buon Description

   

Sync Seings
 

Select for sync options.
 

Related Topics
• Task Sync Options

Sync a Task Between Outlook and Oracle Service Cloud  
Sync a task between Outlook and Oracle Service Cloud.

1. From Outlook,click on the task you want to sync.
2. Click Sync Task.

The Sync Task window opens, conrming that the task from Outlook has been synchronized with Oracle
Service Cloud.

3. Click OK.

Oracle Service Cloud now contains the task you shared from Outlook.

Sync All Tasks Between Outlook and Oracle Service Cloud  
Sync all tasks between Outlook and Oracle Service Cloud.

1. From Outlook, click Sync All Tasks.
A message displays the number of tasks that were synchronized between Outlook and Oracle Service Cloud.

2. Click OK.
The Sync All Tasks window opens, conrming the number of tasks that were synchronized between Outlook
and Oracle Service Cloud.

Tip:  To view details about the individual tasks that were synchronized, click the plus sign next to the
group of tasks you want to view.

3. Click OK.

Email Integration  
You can append Outlook email to contacts, organizations, opportunities, and incidents in Oracle Service Cloud.

Email integration can also be used to create contacts and incidents from Outlook email if no associated email address
exists in the knowledge base at the time of synchronization.

Email integration is a one-way data transfer from Outlook to Oracle Service Cloud. Email data is copied from Outlook
and appended to the selected records in Oracle Service Cloud.

Note:  When email address sharing is enabled, which is the ability for more than one contact to have the same
email address, duplicate email addresses are detected when performing email synchronizations between
Oracle Service Cloud and Microsoft Outlook. If a duplicate email address is discovered, the Sync Email window
displays all contacts that are associated with the email address, along with their individual records. You can
choose one or more of the applicable contacts for email integration. You’ll also have the option to create a new
contact with the shared email address during the synchronization. See Email Address Sharing.
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After email integration is set up on your workstation and an email folder is selected, your Outlook toolbar contains these
buons.

Buon Description

 

Click this drop-down menu to select email sync options.
 

Sync Email
 

Select to append the selected email to an existing contact, organization, opportunity, or incident in
Oracle Service Cloud. If the associated email address is not in the knowledge base, you will have the
option of adding a contact or incident.
 

Sync Seings
 

Select for sync options.
 

Related Topics
• Append Outlook Email to a Record in Oracle Service Cloud

• Email Sync Options

Append Outlook Email to a Record in Oracle Service Cloud  
Append Outlook email to a record in Oracle Service Cloud.

1. From Outlook, select or open the email you want to append to a record in Oracle Service Cloud.

Only one email can be synchronized at a time. Selecting multiple emails will disable Sync Email.

2. Do one of the following:

◦ If you selected the email in a list of messages, click Sync Email on the Outlook toolbar. The Sync Email
window opens.

◦ If you have a new or existing email message open, click the Add-Ins tab and then click Sync Email.

3. To lter the list of returned records, enter the contact’s name, email address, organization name, or associated
record name in the Filter Tree eld and click Go. To return to the original list of records, click Clear.

Tip:  Although wildcards are not supported, you can enter just a few characters in the Filter Tree eld.
After clicking Go, the system will present you with any matching records.

4. Select the appropriate check boxes associated with the addresses in the email. For example, if you select all
check boxes, the same email will be added to the individual Notes tabs of the contact and organization records
as well as all selected opportunities. The email text appears as a private note in the message thread of all
selected incidents.

If the email includes aachments, you can select the aachments you want to include with the email, and they
will appear on the Aachments tab of the selected record. For instance, when you select an aachment under
Append to Contact, the email aachment is stored on the Aachments tab of the contact record in Oracle
Service Cloud. You can also drag Outlook aachments to the Aachments tab of existing records in Oracle
Service Cloud.
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5. If the sender’s email address does not exist in the knowledge base, a red exclamation point and a disabled
check box display next to the email address. You can choose to add a contact record and incident using the
contact’s email address.

6. Click OK to append email to the appropriate records in Oracle Service Cloud.

After a successful synchronization, Sync Email is disabled for that message.

This image shows an email after it has been appended to the Notes tab of the opportunity.

Install Oracle Service Cloud SmartTag  
Oracle Service Cloud lets you install a smart tag that recognizes incident reference numbers in email messages.

If you are using Outlook 2007, smart tags must be enabled through  Tools > Options > Mail Format > Editor Options >
Proong > AutoCorrect Options > Smart Tags .

If you are using Outlook 2010 or 2013, smart tags must be enabled through  File > Options > Mail > Editor Options >
Proong > AutoCorrect Options > Actions .

Outlook recognizes certain types of data in your email, and lets you perform actions on that data. Oracle Service Cloud
SmartTag recognizes incident reference numbers in email messages. When you right-click the reference number in an
email, the incident automatically opens in Oracle Service Cloud.

1. Close Outlook.
2. In Oracle Service Cloud, click File and select  Links > Install Incident Reference Number Smart Tag .

The SmartTag Setup Wizard opens.
3. Click Next to open the Select Installation Folder window.

Tip:  We recommend that you install SmartTag in the default location of C:/Program Files/Oracle
Service Cloud SmartTag.

4. To install SmartTag in a dierent location, click Browse, select the folder where you want to install SmartTag,
and click OK.

5. To see a list of the drives where SmartTag can be installed, click Disk Cost. Click OK when you are nished.
6. Click Next to open the Conrm Installation window.
7. Click Next to begin the installation.

After the installation is complete, the Installation Complete window opens.
8. Click Close to complete the installation.
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Open an Incident Using Oracle Service Cloud SmartTag in Outlook  
Open an incident using Oracle Service Cloud SmartTag in Outlook.

In Outlook 2007, the incident number is underlined with a doed purple line, indicating it is a smart tag. In Outlook 2010
and 2013, the incident number is not underlined.

1. Hover over the incident number smart tag in the email message.
The smart tag indicator appears.

2. Click the smart tag indicator and select Open Incident within Service Console.

Note:  If you are using Outlook 2010 or 2013, you must right-click the reference number and select
Additional Actions to open the incident and view smart tag preferences.

If the Service Console is already open, the incident opens. If the Service Console is not open when you select
Open Incident, you must log in to Oracle Service Cloud for the incident to open.

Oracle Applications Integration  

Oracle Applications Integrations with Oracle Service Cloud  
Oracle Service Cloud supports integrations with a host of other Oracle applications to add industry-leading, cuing-
edge capabilities to your implementation.

Current oerings include:

• Oracle Commerce Service Center

• Oracle Engagement Engine Cloud Service

• Oracle Knowledge Management

• Oracle Policy Automation Cloud Service

• Oracle Sales Cloud

• Oracle Social Network

• Oracle Social Cloud

• Oracle Marketing Cloud
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Note:  For more information about any of the Oracle products listed here, contact your Oracle account
manager.

Oracle Commerce Service Center  
With the integration of Oracle Commerce Service Center, you can quickly take needed actions and respond to
commerce support questions directly from Oracle Service Cloud.

After integration, contacts created in Commerce Service Center (CSC)—formerly ATG Commerce Service Center—are
synchronized with Oracle Service Cloud, enabling you to use the Service Console to:

• Respond quickly to commerce support questions.

• View existing CSC contact information and order details.

• Take action on an existing CSC order or place a new order in CSC on behalf of the customer.

For more information about Oracle Commerce Service Center, see the  Oracle Commerce Service Center Documentation
.

Note:  Oracle Commerce Service Center must be enabled and congured by Oracle. Contact your Oracle
account manager.

How You Work with Oracle Commerce Service Center on the Service Console  
With the integration of Oracle Commerce Service Center (CSC), you can respond quickly to commerce support questions
from the agent desktop.

Contacts are synchronized between Oracle Commerce Service Center (CSC) and Oracle Service Cloud, leing you view
CSC contact information and order details on the Service Console. From there, you can take action on an existing CSC
order or place a new order in CSC on behalf of the customer.

Note:  CSC must be enabled. Contact your Oracle account manager.
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You can add two controls, ATG Contact Details and ATG Contact Orders, to a custom contact workspace that give you
quick access to CSC information, including contact information and order details. See Add a Control to the Design Space.

Additionally, you can add the CSC Shop buon to the contact or incident ribbon for easy access to the CSC. The Shop
buon opens CSC in a new browser window. See Customize the Ribbon.

Oracle Engagement Engine Cloud Service  
Oracle Service Cloud supports integration with Oracle Engagement Engine Cloud Service.

The integration of Oracle Engagement Engine Cloud Service—formerly ATG Engagement Engine—gives you greater
control over when, where, and how proactive and reactive chats are provided to your customers. In addition, it gives
you information about what pages on your customer facing website your customers were viewing when they decided to
initiate a chat, and lets your customers request a phone call from an agent.

For more information about Oracle Engagement Engine Cloud Service, see the  Oracle Engagement Engine Cloud
Service Online Documentation Library .

Note:  Oracle Engagement Engine Cloud Service must be enabled and congured by Oracle. Contact your
Oracle account manager.
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Oracle Knowledge Management  
You can integrate Oracle Service Cloud with Oracle Knowledge Management to provide a full-featured knowledge
authoring and management solution, enabling contact center agents and customers to quickly and easily nd accurate
answers to customer inquiries from within the agent desktop and customer portal.

The Oracle Knowledge Management integration leverages best-in-class content authoring and content management
capabilities that enable agents and authors to create content that can be segmented for specic audiences, products,
and categories, and managed and published using content versioning and history and exible workows, including
translation support. For agents and customers, Oracle Knowledge Management patented Intelligent Search technology
nds exact answers to questions based on their meaning, and to search unstructured content, structured data sources,
and transactional business applications in parallel. Oracle Knowledge Management incorporates customer context, call
context, and system contextual information to provide highly relevant answers to customer questions.

• Customer Portal—Oracle Knowledge can be embedded in the customer portal to provide customer-facing
natural language search and intent-based solutions. Unlike typical self-service solutions that merely parse
search terms, Oracle Knowledge uses natural language processing to understand the true intent of the
customer’s inquiry. Then, using other search enhancement features, such as industry-specic libraries, it
identies and presents the best possible answer. Oracle Knowledge in Customer Portal increases resolution
rates while reducing calls and support costs, transforming the self-service experience.

• Agent Desktop—The Oracle Knowledge integration with Agent Desktop embeds the same intent-based
search functionality directly within the dynamic agent desktop to maximize agent productivity and improve
call resolution rates. In addition, Oracle Knowledge streamlines the call wrap-up process by automatically
providing embedded links to associate the right knowledge with each service request resolution task. You can
also congure incident workspaces with the Oracle Knowledge options available to the workspace proles.

For more information about integrating with Oracle Knowledge, see the  Oracle Knowledge for RightNow Integration
Guide .

Oracle Policy Automation Cloud Service  
Oracle Policy Automation Cloud Service (Policy Automation) interviews can be embedded as questionnaires in the
Service Console and Agent Browser UI by using a workspace control, and in your customer portal by adding the
provided sample widget. Interviews can also be delivered on mobile devices.

Policy Automation is especially useful when customer service must comply with regulations or internal company
policies. When policy changes occur, rules and interview ows can quickly be updated and re-deployed, ensuring your
organization's advice is always accurate and up-to-date. Policy Automation features include:

• Easy mapping of Oracle Service Cloud data into and out of Policy Automation interviews.

• A management console for tracking and deploying policy versions.

• Web services for integrating decision-making with other applications and processes.

• The ability to generate pre-populated PDF forms, using the built-in Business Intelligence Publisher integration.

A broad range of industries use Policy Automation including:

• Public sector, for applications like benet entitlements, licensing, and border control operations.

• Higher education, for scholarship eligibility, transfer credit assessments, and course prerequisites.

• Financial services, for insurance claims, premium calculations, and loan eligibility.

This image shows an example Policy Automation interview delivered on the customer portal.
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Microsoft Word (or Excel) is used to author rules.
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For complete information see  Answer ID 5597 .

Note:  Oracle Policy Automation must be enabled and congured by Oracle. Contact your Oracle account
manager.Oracle Policy Automation is available for integration with the following releases:

• Service Console: February 2013 and later

• Agent Browser UI: August 2015 and later

Oracle Sales Cloud  
Oracle Service Cloud supports integration with Oracle Sales Cloud.

Using the Sales Accelerator for Oracle Service Cloud, service agents can:

• View all Oracle Sales Cloud opportunities for organizations (B2B) and contacts (B2C).

• Create opportunities and sales leads in Oracle Sales Cloud directly from incidents in Oracle Service Cloud
for contacts associated with organizations (B2B), or not associated with organizations (B2C). Assign these
opportunities and leads automatically to the primary account managers in Oracle Sales Cloud.

• View all sales leads and opportunities created in Oracle Service Cloud. Filter the leads and opportunities by
incident, service representative, contact, or organization.

For more information about the Sales Accelerator for Oracle Service Cloud, see  Answer 4755  on our support site.
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Oracle Social Network  
When Oracle Social Network is integrated with Oracle Service Cloud, agents can collaborate with other agents to more
quickly resolve customer questions.

Oracle Social Network (OSN) can be integrated with the agent desktop. From the incident workspace, agents can create
conversations containing the details of their ndings and post questions to other agents. This collaboration encourages
knowledge sharing among your sta and decreases response time to customers.

For more information about OSN, see  Collaborating Through Social Networking in Oracle Service Cloud .

Note:  To enable and congure OSN, contact your Oracle account manager.

Oracle Social Cloud  
Oracle Service Cloud supports integration with Oracle Social Cloud.

After integration, Oracle Social Cloud community managers can escalate a social post to create a contact and incident
in Oracle Service Cloud. The agent assigned to the incident responds just as if it were any other incident. The incident
reference number and incident status are published to the original post in the community.

A Twier or Facebook channel must be congured in Oracle RightNow Social Monitor Cloud Service in order for Oracle
Social Cloud to communicate with Oracle Service Cloud from either Twier or Facebook.

Note:  Oracle Social Cloud Engage must be enabled and congured by Oracle. Contact your Oracle account
manager. The Oracle Social Cloud Accelerator for Oracle Service Cloud might be more appropriate depending
on your business needs. See  Answer 5436  for more information.

Related Topics
• Oracle Social Cloud User Guide

Oracle Marketing Cloud  
Oracle Service Cloud supports integrations of Oracle Eloqua and Oracle Responsys with Oracle Marketing Cloud.

The following integrations with Oracle Marketing Cloud are supported:

• Oracle Eloqua—Bidirectional synchronization of organizations and contacts

• Oracle Responsys—Synchronization of contacts from Oracle Service Cloud to Oracle Responsys

The integrations are created using precongured adapters in Oracle Integration Cloud Service. For more information,
see the following articles:

• Integrating Oracle Marketing Cloud (Eloqua) with Oracle Service Cloud (Doc ID 2234180.1)

• Integrating Oracle Marketing Cloud (Responsys) with Oracle Service Cloud (Doc ID 2194429.1)
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Reference Information  

Reference Information  
Oracle Service Cloud uses format tokens for date and time, regular expressions, shortcut keys and SmartSense.

Oracle Service Cloud uses date and time format tokens to determine how dates and times are expressed throughout the
application and how results are grouped in analytics. See Date and Time Format Tokens for Analytics and Date and Time
Format Tokens for Conguration Seings.

Regular expressions use operators and character strings to specify a set of character strings. See Regular Expressions.

To help you be more ecient and quickly navigate Oracle Service Cloud, default shortcut keys are included for creating
records and other items, navigating the console and content pane, and performing functions. See Shortcut Keys.

SmartSense can help you determine the aitude of customers and sta members in incident correspondence, customer
responses to Oracle RightNow Feedback Cloud Service (Feedback) surveys, and in posts returned from cloud searches.
See SmartSense and How You Evaluate SmartSense Ratings.

Date and Time Format Tokens for Analytics  
Use these format tokens to specify date and time formats in reports.

Token Description

HH24
 

Displays hours in 24-hour format. For example, 1 PM = 13.
 

HH12
 

Displays the hour in 12-hour format. For example, 5 PM = 5.
 

HH
 

Displays the hour in 12-hour format. For example, 5 PM = 5.
 

AM
 

Displays the AM/PM indicator.
 

PM
 

Displays the AM/PM indicator (same function as AM).
 

MI
 

Displays the minutes as a two-digit number.
 

SS
 

Displays the seconds.
 

D
 

Displays the numeric day of the week with Sunday as zero. For example, Monday =1.
 

DD
 

Displays the numeric day of the month.
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Token Description

DDD
 

Displays the numeric day of the year. For example, April 7 = 97.
 

DY
 

Displays the three-leer abbreviation for the day of the week. For example, Monday = Mon.
 

DAY
 

Displays the full day name. For example, Monday.
 

WW
 

Displays the week of the year as a number. The week begins on a Sunday, so the rst week (week 1) of
a new year is the rst week that contains a Sunday. For example, in 2015, the rst Sunday was January
4th. This means that the dates January 1st through 3rd of 2015 are considered to part of the last week
of the previous year. So, February 22, 2015 = 8.
 

WWW
 

Displays the full month name followed by the rst date of the week. For example, Sunday July 27, 2008
= July 27. This can be useful to identify a week by its start date rather than simply seeing a number as
provided with WW.
 

WEEKS
 

Rounds the entered date value to the beginning of the week, using Sunday as the start of the week. For
example, Thursday July 16, 2009 = 07/12/2009.
 
This token can be used only with the date_add and date_trunc functions.
 

IWEEKS
 

Rounds the entered date value to the beginning of the week, using Monday as the start of the week.
For example, Thursday July 16, 2009 = 07/13/2009.
 
This token can be used only with the date_add and date_trunc functions.
 

MM
 

Displays the month as a two-digit number. For example, November = 11.
 

MON
 

Displays the three-character abbreviated month name. For example, March = Mar.
 

MONTH
 

Displays the full month name. For example, March.
 

Q
 

Displays the numeric quarter of the year. For example, October 31 = 4.
 

YY
 

Displays the last two digits of the year. For example, 2008 = 08.
 

YYYY
 

Displays the four-digit year. For example, 2008.
 

YYYX
 

Displays the international four-digit year around the end of or beginning of the year. For example,
December 31, 2008 = 2009. This is used in conjunction with WW such that all week grouping will
consistently include 7 days even at the start and end of the calendar year. YYYX will return the Year for
the week where Sunday is the rst day of the week. For example, if grouping by Year/Week (WW), even
though the dates January 1, 2015 through January 3, 2015 occur in 2015, since they are included with
WW as being in week 52 (last week of 2014), YYYX will keep the year consistent and return 2014. If you
are going to group by week using WW and want to include the Year number, use YYYX.
 

YYIX
 

Displays the international four-digit year. This is used in conjunction with IW such that all week
groupings consistently include 7 days even at the start and end of the calendar year.YYIX will return
the Year for the week where Monday is the rst day of the week. For example, even though the dates
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Token Description

December 29, 2014 through December 31, 2014 occur in 2014, since they are included with IW as being
in week 1 (rst week of 2015), YYIX will keep the year consistent and return 2015. If you are going to
group by week using IW and want to include the Year number, use YYIX.
 

J
 

Displays the Julian date. For example, 2008-08-08 11:18:30 = 733627.
 

IW
 

Displays the international week of the year as a number. IW follows ISO 8601:1988 standards. The IW
week begins on a Monday and ends on a Sunday. The rst week (week 1) of a new year is the rst week
that contains four or more days in that year. For example, in 2015, January 1st was a Thursday. This
means that the week beginning on Monday, December 29, 2014 contains 3 days in 2014 and 4 days
in 2015. So, any dates in that time period will be week 1 (of the new year). For example, December 30,
 2014= 01.
 

IWW
 

Displays the international full month name followed by the rst date of the week. For example,
 Wednesday December 31, 2007 = December 31. This can be useful to identify a week by its start date
rather than simply seeing a number as provided with IW.
 

Token Description

DD
 

Displays the number of days.
 

HH
 

Displays the number of hours.
 

MI
 

Displays the number of minutes.
 

SS
 

Displays the number of seconds.
 

Date and Time Format Tokens for Conguration Seings  
Use these format tokens to specify date and time formats in conguration seings.

Token Description

%a
 

Displays the three-character abbreviated weekday name. For example, Monday = Mon.
 

%A
 

Displays the full weekday name. For example, Monday.
 

%b
 

Displays the three-character abbreviated month name. For example, March = Mar.
 

%B
 

Displays the full month name. For example, November.
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Token Description

%d
 

Displays the two-digit numeric day of the month. The rst through ninth days of the month are
preceded by a zero (01-09).
 

%D
 

Displays the date as MM/DD/YY (same as %m/%d/%y).
 

%e
 

Displays the numeric day of the month. The rst through ninth days of the month are not preceded by
a zero.
 

%H
 

Displays hours in 24-hour format. For example, 1 PM = 13.
 

%I
 

Displays the hour in 12-hour format. For example, 5 PM = 5.
 

%j
 

Displays the numeric day of the year. For example, April 7 = 97.
 

%m
 

Displays the month as a two-digit number. For example, November = 11.
 

%M
 

Displays the minutes as a two-digit number.
 

%n
 

Inserts a hard return.
 

%p
 

Displays the AM/PM indicator.
 

%r
 

Displays the time as HH:MM:SS AM/PM (same as %I:%M:%S %p).
 

%R
 

Displays the time as HH:MM (same as %H:%M).
 

%S
 

Displays the seconds as a two-digit number.
 

%t
 

Inserts a tab character.
 

%T
 

Displays the time as HH:MM:SS (same as %H:%M:%S).
 

%y
 

Displays the last two digits of the year. For example, 2008 = 08.
 

%Y
 

Displays the four-digit year. For example, 2008.
 

%z
 

Displays the abbreviated time zone name. For example, Mountain Standard Time = MST.
 

%Z
 

Displays the full time zone name. For example, Mountain Standard Time.
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Regular Expressions  
Regular expressions use operators and character strings to specify a set of character strings. They can be used when
conguring business rules to allow more exibility in the criteria used to route incidents. Regular expressions can also
be used in mailbox lters and custom objects.

Note:  Since the values in drop-down menus are xed, using regular expressions to match items in a drop-
down menu (for example, Product or Category) is not supported. If you want to include an If condition for
items in a drop-down menu, use EQUALS or CONTAINS instead of a regular expression.

The rst table below lists some of the regular expression operators that work with business rules and mailboxes. Oracle
Service Cloud accepts any regular expression using POSIX Extended syntax. The second table lists examples of how
regular expressions can be used.

Regular expressions begin and end with slash (/) delimiters, but they are not required when using regular expressions
in business rules or report lters. However, slashes are used to separate multiple regular expressions in some
conguration seings, such as EGW_AR_MODR_HEAD_FLTR.

Action Description

[ ]
 

Matches any character in the brackets.
 

[0-9]
 

Matches any number between 0 and 9.
 

[A-Z]
 

Matches any character A-Z or a-z.
 

[^]
 

Matches any characters NOT in the brackets. The rst character in the brackets must be ^.
 

text1|text2
 

The pipe character acts as a Boolean OR, so text1 OR text2 results in a match.
 
Do not include a pipe at the beginning or end of a regular expression.
 

.
 

Matches any single character except a new line.
 

?
 

The preceding item is optional and matched at most once.
 

*
 

The preceding item is repeated as many times as necessary to match. Also matches if preceding item is
not present.
 

+
 

The preceding item is matched one or more times.
 

{n}
 

The preceding item is matched exactly n times.
 

{n,}
 

The preceding item is matched n or more times.
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Action Description

{n,m}
 

The preceding item is matched at least n times, but not more than m times, and as few times as
possible.
 

( )
 

Used to group elements of the regular expression, as in arithmetic.
 

\w
 

Any alphanumeric character.
 

^
 

Match if at start of line.
 

$
 

Match if at end of line.
 

\
 

Quote or escape a character that would otherwise be interpreted as a syntactic character. Characters
that must be quoted are: + ? | ( ) { }
 

\<text\>
 

Match the string (case insensitive) only if it is surrounded on both sides by any non-word character
(i.e. a space, dash, or a special character (!$%^.<>*|()?/\ : ;)). Note that alpha-numeric characters and
underscores are considered word characters.
 

This regular expression... matches...

^Example
 

“Example” at the beginning of a line
 

Example$
 

“Example” at the end of a line
 

^Example$
 

“Example” as the only word on the line
 

^...$
 

any line with exactly three characters
 

......-.....1
 

any reference number ending in “1”
 

t.e
 

tae, tbe, tce, t%e, tie, the, toe...
 

at*e
 

ae, ate, ae, ate, ae...
 

at+e
 

ate, ae, ate
 

at?e
 

ae, ate
 

m[aeiou]t
 

mat, met, mit, mot, mut
 

cat|mat cat, mat
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This regular expression... matches...

   

lo{4}ng
 

loooong
 

lo{2,4}ng
 

loong, looong, loooong
 

ward | ward\. | ^ward
 

“ward” surrounded by spaces (this prevents “forward” or “backward” from matching), “ward” at the end
of a sentence, and “ward” at the beginning of a line (no preceding space)
 

\<jump\>
 

Jump, jump, JuMp, etc. The regular expression does not match jumping, jumped, etc.
 

Shortcut Keys  
To help you be more ecient and quickly navigate Oracle Service Cloud, default shortcut keys are included for creating
records and other items, navigating the console and content pane, and performing functions.

Tip:  You can hover over buons on ribbons to display shortcut keys. In addition, you can press the Alt key plus
the rst leer of the ribbon tab to display shortcut keys for the tab.

Shortcut Key Action

New Item
 

Ctrl+Shift+I
 

Incident
 

Ctrl+Shift+A
 

Answer
 

Ctrl+Shift+P
 

Opportunity
 

Ctrl+Shift+C
 

Contact
 

Ctrl+Shift+O
 

Organization
 

Ctrl+Shift+T
 

Task
 

Ctrl+Shift+B
 

Dashboard
 

Ctrl+Shift+R
 

Report
 

Ctrl+Shift+G
 

Campaign
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Shortcut Key Action

Ctrl+Shift+Y
 

Survey
 

Ctrl+Shift+M
 

Mailing
 

Ctrl+Shift+D
 

Document
 

Ctrl+Shift+E
 

Guided assistance guide
 

Tab Switching
 

Ctrl+Tab
 

Return to previous content pane tab in history
 

Ctrl+Shift+Tab
 

Move forward to next content pane tab in history
 

Ctrl+W or Ctrl+F4
 

Close the current content pane tab
 

Global
 

F3
 

Make the Quick Search tool window active. If Quick Search is closed, pressing F3 will open it in an
undocked window.
 

Alt+F4
 

Exit Oracle Service Cloud
 

Text Editing
 

Ctrl+A
 

Select all
 

Ctrl+C
 

Copy
 

Ctrl+X
 

Cut
 

Ctrl+V
 

Paste
 

Ctrl+left/right arrow
 

Move forward or backward one word
 

Del
 

Delete
 

Record Editing
 

F1
 

Help
 

F7 Spell check

563



Oracle Service Cloud
Using Service Cloud

Chapter 2
Core Features

Shortcut Key Action

   

Ctrl+N
 

New (same item type)
 

Ctrl+S
 

Save
 

Ctrl+Shift+S
 

Save and close
 

Ctrl+D
 

Forward
 

Ctrl+I
 

Information
 

Ctrl+P
 

Print
 

F8
 

Appends standard text to an incident when used with standard-text keyboard shortcuts.
 

Explorers, Tree Operations, and Reports in Explorers
 

F1
 

Help
 

F2
 

Rename
 

F5
 

Refresh
 

F12
 

Save as (available only in those explorers and reports that contain a Save As buon on the ribbon)
 

Ctrl+A
 

Assign (available only in those reports that contain an Assign buon on the ribbon)
 

Ctrl+E or Enter
 

Edit selected item
 

Ctrl+F
 

Find
 

Ctrl+R
 

Refresh
 

Del
 

Delete
 

Records Reports and Individual Records
 

F1
 

Help
 

F5
 

Refresh
 

Ctrl+F1 Minimize the ribbon
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Shortcut Key Action

   

Ctrl+A
 

Assign
 

Ctrl+C
 

Copy
 

Ctrl+E or Enter
 

Edit selected item
 

Ctrl+D
 

Forward
 

Ctrl+N
 

New (uses default new selection)
 

Ctrl+P
 

Print
 

Del
 

Delete
 

Related Topics
• Display Shortcut Keys on the Ribbon

SmartSense  
SmartSense can help you determine the aitude of customers and sta members in incident correspondence, customer
responses to Oracle RightNow Feedback Cloud Service (Feedback) surveys, and in posts returned from cloud searches.

When working with incidents or reviewing survey responses or cloud search results, you can use SmartSense to
determine which customers need immediate aention and when to notify supervisors or other sta members about
specic incidents or situations. The emotive rating can also be used as a condition in incident rules.

In incidents, two SmartSense ratings can be placed on the incident workspace: one for the customer and one for the
sta member editing the incident. SmartSense scans the text and rates the words and phrases in all customer entries
for the customer rating and all responses for the sta member rating.

Although the following descriptions discuss SmartSense as it applies to incidents, it also applies to surveys and cloud
monitoring. In surveys, responses to text questions, including SmartSense evaluations of each response, appear on the
Results tab of the survey. See Topic Monitoring. In cloud monitoring, SmartSense ratings appear in reports next to cloud
search results. See Add a Cloud Search.

Note:  SmartSense recognizes modiers and negatives in all supported languages as well as some emoticons
and acronyms. The SmartSense rating may be exaggerated if emotive words are set in all capital leers or the
sentence contains an exclamation point.

When your administrator adds Contact SmartSense, Sta SmartSense, or both to the workspace you use for working
on incidents, you will see the colored meter on the workspace. This image shows an incident workspace with both
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SmartSense meters displayed. The workspace you use for incidents depends on your prole and how your administrator
congured incident workspaces.

The SmartSense meter on the Results tab for responses to a Feedback text question appears the same as it does on the
incident workspace.

On a new incident, both meters start at neutral. This is represented by the neutral face icon displayed in the center of
the meter. Each time the incident is updated by the customer on the customer portal, the contact SmartSense rating
is updated. When a sta member adds a response on the incident workspace, the sta SmartSense rating is updated.
Current threads are weighted more heavily than earlier threads. The contact SmartSense rating is not aected when
a sta member updates an incident on the incident workspace by adding a customer entry. Only comments that the
customer makes through the customer portal are evaluated for the SmartSense rating.

The farther to the left (the red zone of the meter), the more negative the rating, while ratings toward the right, or blue
zone, are more positive.

Only response threads are considered for the sta SmartSense rating in incidents, as note threads are not evaluated.
Additionally, SmartSense processes only the rst 4,000 words in each incident thread rather than the entire thread,
helping to make emotive indexing process faster for incident threads with a large number of words.

How You Evaluate SmartSense Ratings  
While SmartSense is an eective tool for assessing a customer’s general aitude, it may not always provide a completely
accurate rating.

As a single rating, the SmartSense rating may be an oversimplication. If a word has several meanings, the SmartSense
rating may not be exactly precise for one or more of the meanings. If a word is not in the SmartSense list, it will not
be considered, and sentences containing complex negation or qualication could be misinterpreted by SmartSense.
If a customer writes both positive and negative remarks in an incident (for example, is pleased with the product but
expresses anger or frustration about a support issue), the emotive rating may result in a neutral value, since the
extreme words will balance each other. Despite these potential diculties, SmartSense gives a useful overall estimate of
emotional levels and can help you provide superior service to your customers.

While the SmartSense word list is proprietary and cannot be viewed, your administrator can specify word ratings that
extend or override those used by SmartSense. This allows custom values for words that have specic meanings for a
particular organization or industry.
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Your administrator can also disable SmartSense. If disabled, SmartSense evaluations are not performed on incidents,
survey results, and cloud search results, and emotive rating options are not available when choosing conditions for
business rules.

Related Topics
• Wordlist Files
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3  Dynamic Agent Desktop

Dynamic Agent Desktop  

Overview of the Dynamic Agent Desktop  
The dynamic agent desktop in Oracle Service Cloud is your sta members’ portal to your knowledge base.

The dynamic agent desktop is comprised of a set of complementary features, each representing a dierent, powerful
way of interacting with records. While each component serves a distinct purpose, they can be used together to create a
highly adaptive work environment. This can help you match your customers’ needs to an appropriate set of agent tools
and free your sta to focus only on those parts of the process that cannot be automated.

To get the most from your agent desktop, be sure to review each feature and consider how it can help your team. The
desktop features listed here share common concepts and functionality, so after you are familiar with one desktop
feature, learning the others becomes easier. For example, after you learn to create workspaces, you will have most of
the knowledge you need to create agent scripts.

Tip:  For a list of best practices for selecting the most appropriate features of the agent desktop to match your
business needs, see  Best Practices for Implementing Contact Center Experiences .

As you evolve beyond the default conguration to an optimized interface, you will increase agent productivity and
extend the impact of their actions, producing a more dynamic, responsive operating environment. Keep in mind that all
of the agent desktop features apply to the Service Console. However, many features are also supported on the Agent
Browser UI. For a complete list of supported features, see  Answer ID 8173  on our support site.

Feature/Icon Description

Workspace—A conguration of the content pane, including the elds, controls, and ribbon that display
when working with answers, assets, contacts, incidents, opportunities, organizations, or tasks; when
working in Oracle RightNow Chat Cloud Service; or when working with quotes, quote products, or
service opportunities. Standard workspaces are provided for each of these workspace types, and
custom workspaces can be created. The workspaces sta members use depend on their prole. See
Overview of Workspaces.
 

Workspace rules—Rules that dynamically adjust the display, behavior, and values of elds and controls
on a workspace based on sta member actions. Each rule is triggered by one or more events and
conditions. See Workspace Rules.
 

Guide—An interactive tool that helps agents quickly locate solutions when composing incident
responses or troubleshooting customer issues over the phone. Guides are built using controls to
display questions, branches, text explanations, and answer links. They can be added to workows,
 placed on workspaces, or presented on the customer portal. See Overview of Guided Assistance.
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Feature/Icon Description

Agent script—A series of pages connected by branching logic that help agents enter information in
a logical order. Scripts are built using elds and controls to display questions, text, and answers, and
update records. They can be added to workows or placed on workspaces. See Overview of Agent
Scripts.
 

Script rules—Rules used to trigger actions (such as seing the value of a eld or calling a named event)
on script pages when specic conditions are met. Like workspace rules, each script rule is triggered by
one or more events and conditions. See Script Rules.
 

Desktop workow—A sequence of workspaces, scripts, decisions, connectors, and actions presented
to sta members as a dynamic interface to eciently support and automate complex business
processes. See Overview of Desktop Workows.
 

Add-ins—The desktop add-in framework allows application developers to add custom components,
or “add-ins,” to Oracle Service Cloud in order to integrate with other applications on sta members’
workstations. When you upload an add-in, you can place it on scripts and workspaces in the same way
you add controls, such as report or browser controls. The add-in can be displayed anywhere you want
on the script or workspace or you can hide it using functionality in the script and workspace designers.
You can also congure script branches and script and workspace rules to communicate with the add-in.
See Overview of Add-Ins.
 

Considerations for Mapping Your Business Processes to the Agent
Desktop  
Time spent dening a business process is a worthwhile investment. Decisions made before implementation can save
much time and trouble later on. Careful consideration of all aspects of a business process can make it more eective
and easier to maintain and can help to avoid process holes and bolenecks.

The rst step in mapping your organization’s processes to the agent desktop is to clearly dene your business needs.
Whether your goals are simple or complex, certain basic parameters should be identied and accounted for in your
desktop design. Here, we’ll provide you with some basic questions to help you identify the requirements and resources
you will need to structure and rene your business processes.

Put simply, a process is a sequence of events—actions followed by other actions, governed by conditions and
augmented by exceptions. Following is a sampling of essential questions that should be answered in preparation for
dening a fully formed process.

Tip:  After you have answered these questions, see  Best Practices for Implementing Contact Center
Experiences  for best practices that include specic techniques for mapping your processes to the agent
desktop and developing exceptional agent desktops.

• What activities are you supporting? What is your primary goal and responsibility for the process you are
dening? Are you developing an entirely new process from scratch, or are there existing processes or systems
that should be considered? If you are integrating with an external system, is there any functional overlap that is
easier to manage within Oracle Service Cloud?
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• Who are your stakeholders? Identify everyone who has an interest in the success (or failure) of your process.
Success is dened by accounting for and delivering on all needs of your consumers, sta, group managers,
directors, and executives. To achieve that success, it is important to give these stakeholders a voice when
designing and testing your business process.

• What outputs are required? For each stakeholder, list the specic process output that they require to fulll their
needs. List any events and conditions that factor into those outcomes and, when appropriate, dene alternate
outcomes for cases where exceptions to those criteria occur. For example, each of these stakeholders requires a
specic output that their business process must account for:

◦ A customer may need an answer to a question or service for a product they have purchased.

◦ A manager may need custom reports to ensure that customer requests are met within a specied time
period and that satisfaction scores are high.

◦ A director from another department may be responsible for incorporating customer feedback into
initiatives for new products or services.

◦ A sales executive may be responsible for acting on business opportunities or account issues identied by
your agents.

• What are your channels? How are you communicating with your customers—email, telephone, or chat? Are you
monitoring the social cloud or providing a community to promote your services? Is your team logging incidents
or opportunities manually, or are they being generated by some other means?

• Who are your resources? Identify the people who will be responsible for completing any necessary tasks. For
example, who will be responsible for viewing and responding to customer inquiries? To whom will they escalate
outstanding or complex issues? Who will be charged with developing and monitoring team performance? And
who will be charged with maintaining these processes as needs change in the future? Do these people have
sta accounts in Oracle Service Cloud with appropriate prole permissions?

• What can be automated? As you list the resources needed to service your stakeholders, consider each
task carefully and ask yourself, “Does this output require human interaction, or can it be wholly or partly
automated?” Can you reduce the number of human resources you require, or the time you require of them,
while delivering full value to your stakeholders? With desktop automation, you might be surprised how often
the answer is “Yes.” The more tasks that are automated, the more focused your team will be on tasks that
actually require their aention.

• What is your testing strategy? After your process denition is complete, how will you test it? Is it large enough
that it should be rolled out in phases, or to a subset of your users in advance? Do agents have a means for
providing you with meaningful feedback? The more complex your processes, the more important it is to fully
test all scenarios your agents may encounter and ensure all process outputs are sucient for stakeholder
needs.

After you have answered these questions, you are ready to begin dening your business process. At a very basic level,
this involves listing the required actions, the conditions under which they occur, and any alternate outputs stemming
from exceptions, and ordering them in an appropriate sequence. Then, you might sketch out a chart or detailed diagram
to illustrate the ows implied by those business needs. Illustrating the order of action with a ow diagram can help
you understand the ner nuances of your process and make it easier to verify your logic. For example, you may nd
instances where one part of a process overlaps another or creates a boleneck, giving you the opportunity to streamline
and increase the eectiveness of your ow.

Guidelines for Testing Your Agent Desktop Design  
As you carefully map out and design your dynamic agent desktop, be sure to test it thoroughly before deploying to your
operational environment.
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Here are some helpful guidelines.

• Make frequent use of preview and validation—As you design workspaces, guides, scripts, workows, and rules,
make a habit of correcting mistakes to your work as you go. The Home tab of each editor provides a Preview or
Validate buon to help you check for problems. If you correct conguration issues promptly, you will probably
nd them easier to resolve because your design decisions should still be fresh in your mind.

• Account for the prole restrictions of your agents—When you preview a workow or a script, it will display as it
would to any sta member who has the same set of prole permissions you have. To view it as it will appear to
a specic sta member with dierent permissions, log in using a test account with the same prole as that sta
member.

• Phase in major changes—In some cases, testing in a non-production environment may not nd every conict
or hole in your process. Workspaces and workows are specic to each prole, so if an agent desktop is
designed to be used by multiple proles across a large number of agents, you might also consider rolling it out
in phases, or to a small subset of your sta before taking it fully live.

• Invite suggestions for improvement—Incorporate a method (such as an incident submission element or internal
survey) for your agents to submit feedback about any problems found or suggestions for further renements.
And consider keeping it in place to augment your standard processes—timely, specic feedback can be just as
useful during day-to-day production use as it is during the testing phase.

Workspaces  

Overview of Workspaces  
Workspaces dene the appearance of the agent desktop when sta members add, view, and edit records in Oracle
Service Cloud.

When you open a record—such as an incident, contact, opportunity, or custom object—the workspace determines the
layout of elds, controls, and tabs on the content pane as well as the arrangement of buons on the ribbon and the
Quick Access toolbar.

Oracle Service Cloud provides a set of standard workspaces suitable for most common record maintenance, but also
gives you complete exibility to create custom workspaces to help your sta work more eciently. In addition, you can
create workspace rules to dynamically change the behavior of elds and controls based on certain triggering events.

The workspaces used by sta members are dened in their sta prole, with one workspace associated for each type of
record the prole can access. Dierent proles can use dierent workspaces. However, each editor within a prole must
be set to use a specic workspace, so all sta who share a prole will use the same set of workspaces. For example,
when you create an incident workspace and assign it to the incident editor of a specic prole, all sta members with
that prole will see that workspace when they add, view, or edit incidents. See Overview of Sta Management.

Tip:  Many functions used to design workspaces are also used to design agent scripts. To understand how
workspaces can best be implemented in your agent desktop, you should also become familiar with guides,
scripts, script rules, and workows. For a summary of these features, see Overview of the Dynamic Agent
Desktop.
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Open the Workspaces Explorer  
The Workspaces explorer is used to access and manage all of the workspaces on your site. With this explorer, you can
browse, search, and organize workspaces in hierarchical folders on the content pane using functions similar to Windows
Explorer.

Initially, the explorer lists only the Standard folder containing the standard workspaces. The folder is read-only and
the standard workspaces cannot be opened, edited, or deleted—they exist mainly to be selected in sta proles.
However, you can copy standard workspaces to use as the basis for creating your own custom workspaces. See Create a
Workspace.

Listed next to each workspace name is its workspace type, based on the type of record it opens. The workspace
type determines which elds and controls can be added to the workspace. For example, the Incident workspace type
provides access to controls and database elds that are related to incidents. In addition, some workspace types are
multi-edit, meaning they are used when sta members open multiple records of the same record type at the same time
(up to 250 records can be edited at once). This lets you display one workspace when sta members open a single record
and display a dierent workspace when they edit multiple records of the same type simultaneously.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and double-click Workspaces. The Workspaces explorer opens on the

content pane.

Note:  If desktop workows are enabled on your site, you will see Workspaces/Workows listed under
Application Appearance instead. See Create a Desktop Workow. To enable desktop workows, contact
your Oracle account manager.

3. To display the list of standard workspaces, click the Standard folder in the tree under Workspaces.

Standard Workspaces  
Oracle Service Cloud provides a precongured set of standard workspaces, one of each workspace type, suitable
for most common record editing. Each is named for its workspace type and is used as the default workspace for its
corresponding editor for all new proles.

This table lists the standard workspaces and when they are used. Your explorer may list fewer workspaces depending
on which Oracle Service Cloud products are enabled on your site. Contact your Oracle account manager for information
about enabling products. For information about workspaces on the Agent Browser UI, see  Administering the Agent
Browser UI .

Workspace Description Supported in Agent Browser UI

Answer The standard answer workspace that is displayed when a sta member
adds or edits an answer.

Yes

Answer Multi Edit The standard answer workspace that is displayed when a sta member
edits multiple answers.

Yes

Asset The standard assets workspace that is displayed when a sta member adds
or edits an asset.

Yes
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Workspace Description Supported in Agent Browser UI

Asset Multi Edit The standard assets workspace that is displayed when a sta member edits
multiple assets.

Yes

Chat Sessions The standard chat sessions workspace displays when an agent accepts a
chat from a customer or when a supervisor monitors a chat.
The chat sessions workspace uses the chat workspace type.
 

No

Chat Sidebar The standard chat sidebar workspace has no function and is no longer used
in Oracle Service Cloud.

No

Contact The standard contact workspace that is displayed when a sta member
adds or edits a contact.

Yes

Contact Multi Edit The standard contact workspace that is displayed when a sta member
edits multiple contacts.

Yes

Incident The standard incident workspace that is displayed when a sta member
adds or edits an incident.

Yes

Incident Multi Edit The standard incident workspace that is displayed when a sta member
edits multiple incidents.

Yes

Interaction The standard interaction workspace that is displayed when a sta member
chats with a customer on the Agent Browser UI. When a chat is initiated,
 the engagement panel opens with an interaction workspace where contact
information for the chat is created. An incident for the chat is also created if
the sta member has add/edit permissions for incidents.

Yes

Opportunity The standard opportunity workspace that is displayed when a sta member
adds or edits an opportunity.

Yes

Opportunity Multi Edit The standard opportunity workspace that is displayed when a sta member
edits multiple opportunities.

No

Organization The standard organization workspace that is displayed when a sta
member adds or edits an organization.

Yes

Organization Multi Edit The standard organization workspace that is displayed when a sta
member edits multiple organizations.

Yes

Quote The standard quote workspace that is displayed when a sta member adds
or edits a quote.

No

Quote Product The standard quote product workspace that is displayed when a sta
member adds a sales product to a quote.

No

Service Opportunity The standard service opportunity workspace that is displayed when a sta
member adds or edits a service opportunity.
The service opportunity workspace uses the opportunity workspace type.
 

No

Task The standard task workspace that is displayed when a sta member adds or
edits a task.

Yes

Task Multi Edit The standard task workspace that is displayed when a sta member edits
multiple tasks.

Yes

574



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

Standard workspaces are not available for custom objects because custom objects are, by denition, nonstandard
objects. However, you can create workspaces that provide access to custom objects that have Object is Available in
Workspaces, Scripting, and Workow eld visibility.

Custom Workspaces  
In addition to standard workspaces, Oracle Service Cloud gives you complete exibility to create your own custom
workspaces to help your sta work more eciently.

Custom workspaces are used to provide your team with access to records stored in custom objects, which by denition
have no standard workspaces of their own. Custom workspaces are created on a workspace designer (shown here)
consisting of a ribbon and a design space. You dene a workspace by dragging and dropping elds and controls from
the ribbon to the design space.

Legend for image: 1. Summary Panel 2. Tab Set

The design space is the working area where you arrange elds and controls as you want them to appear on the
workspace. In most standard workspaces, a summary panel at the top of the design space displays the most frequently
accessed elds for the record type, while a tab set at the boom provides controls and information related to the record,
such as associated records, le aachments, and an audit log.

The summary panel and tab set both contain a table, hidden by default, that forms an underlying grid for aligning elds
and controls. To aid you in laying out the workspace, you can display outlines around items on the design space to help
you identify the table cells they are in. See Design Space Layout Options.

After you add a eld or control to the design space, you can select it to adjust its properties on the designer ribbon.
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Tab Description

Home Contains buons for managing the entire workspace. You can preview the workspace, customize the
ribbon that will be displayed with the workspace, create workspace rules, add spell-check functionality,
and display an outline on the workspace to guide your design. You can also add notes, review the audit
log, insert elds, and alter display and behavior properties for elds and controls.

Insert Field Lists the elds you can add to the workspace. The type of workspace you select when creating a new
workspace determines the elds available. For example, when creating an incident workspace, you can
add incident, contact, and organization elds. See Workspace and Script Fields.

Insert Control Lists controls and relationship items you can add to the workspace. Controls include spacers, tab sets,
 scripts, reports, title bars, and other items you can use to enhance the display or add functionality.
Relationship items also add functionality to the workspace, but vary based on the type of workspace
you are creating. See Workspace and Script Controls.

Design Displays when you select an item on the design space and contains buons you can use to modify the
properties of the selected item. For example, you can change fonts and margins for a eld, or set a
eld to read-only if you want to display it only for informational purposes. The options available on the
Design tab vary based on the control or eld that is selected.

Tip:  You can double-click an item on the workspace to automatically select the Design tab
and populate it with properties related to the item.

Rules Displays when you select an item on the design space. Using the buons on this tab, you can create
rules that alter the workspace according to the conditions you dene. For example, you can create a
rule to hide a eld when certain sta members use the workspace. See Workspace Rules.

Create a Workspace  
You can create a custom workspace from scratch by starting with a blank workspace. You can also copy an existing
workspace or import a workspace from an exported workspace le to use as the basis for a new workspace.

After you create a custom workspace, you can tailor the design by adding and removing elds and controls, adjusting
properties, and arranging the layout to suit your business needs.

This procedure describes how to create workspaces. To import a workspace from an exported workspace le, see How
You Export and Import Workspaces.

1. From the Workspaces explorer, click New. (If workows are enabled, the buon will be labeled New Workspace.)
The New Workspace window opens.

2. In the Start With a Blank Workspace section, select a workspace type.

Note:  If your site has an Agent Browser User Interface associated with it, a message displays with a
link to more information. Click OK to continue.

The workspace designer opens.
3. To design the workspace, see Edit a workspace.
4. Click Save.

Related Topics
• Edit a Workspace
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Copy a Workspace  
The following procedure describes how to copy a workspace.

1. From the Workspaces explorer, right-click the workspace you want to copy and select Copy.
The Copy Workspace As window opens.

2. Select the folder to which you want to add the copied workspace.
3. Enter a name for the copied workspace in the Name eld.
4. Click OK.

The workspace you added appears on the explorer in the folder you selected.

Delete a Workspace  
The following procedure describes how to delete a workspace.

1. From the Workspaces explorer, right-click the workspace you want to delete and select Delete.
A Conrm Workspace Deletion message appears.

2. Click Yes to delete the workspace.

If you delete a workspace that is selected for a standard object editor in a prole, the prole will revert to the
standard workspace for the editor type. For example, if you delete a workspace that happens to be selected in a
prole for the incident editor, the prole will automatically use the standard incident workspace for that editor.

If you delete a workspace that is selected for a custom object editor in a prole, the prole will revert to no
workspace selection because there are no standard workspaces for custom objects.

Edit a Workspace  
You can edit a workspace to modify what elds, controls, and properties your sta members have access to.

The features available on the workspace designer are the same regardless of whether you are editing a new or existing
workspace, or whether it was created from scratch, from a copy, or from an imported workspace le. However, the
designer ribbon provides access only to elds, controls, and properties that apply to the workspace type. Controls
specic to answers, for example, cannot be added to opportunity workspaces.

By default, most workspace types are blank on top with a single tab on the boom. (Workspaces that are displayed
in their own windows, such as quotes and quote products, are empty.) You can adjust the location of the tabbed area
on the workspace by selecting the workspace on the design space and choosing the location you want from the Tab
Alignment buon on the Design tab. You can also adjust the space alloed to the two main areas of the workspace by
selecting options from the Threshold Height and Summary Panel Height buons on the Design tab.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces. (If workows are enabled, the item is

labeled Workspaces/Workows.)
The Workspaces explorer opens on the content pane.

3. Right-click the workspace you want to edit and select Open.
The workspace opens on the content pane.
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4. Drag the elds you want from the Insert Field tab onto the design space.
5. Drag the controls and relationship items you want from the Insert Control tab onto the design space.
6. To modify the properties for elds and controls, select the item, click the Design tab, and make the appropriate

changes.
7. To customize options specic to chat workspaces, click Options on the Home tab.
8. To customize the workspace ribbon, click Ribbon on the Home tab.
9. To add workspace rules that alter the display or behavior of items on the workspace or the values in its elds,

click Rules on the Home tab. You can also select an item on the workspace and then click Add Rule on the
Rules tab.

Note:  The Rules buon and Rules tab are available only when workspace rules are enabled, and
are not available for multi-edit workspaces. To enable workspace rules, contact your Oracle account
manager.

10. To view a history of all actions taken on the workspace, such as when the workspace was created and edited
and by whom, click Audit Log on the Home tab.

11. To invoke spell checking on elds that have the spell checking property enabled whenever a record that uses
this workspace is saved, click Spell Check on the Home tab and select Auto-Check Spelling on Save.
To permit sta members to cancel automatic spell checking, click Spell Check and select Allow Canceling
Auto-Check. When this option is not selected, sta members will be unable to save the record if they cancel
spell checking.

12. To add notes about the workspace, click Notes on the Home tab to open the Workspace Notes window.
a. Enter any notes you want in the text eld.
b. Click OK.

Notes added to your workspace are for internal use and are visible only when editing the workspace. They do
not appear when working with records.

13. To hide the banner ag on an answer, contact, incident, opportunity, or organization workspace, click the Insert
Control tab and clear the Banner Flag check box.
When visible, sta can use the banner ag to set an importance indicator and enter text pertaining to the
record. The banner ag does not appear on asset, chat, task, quote, quote product, or multi-edit workspaces.

14. To see what your workspace will look like when it is used by sta members, click the Home tab and click
Preview. You can choose to see the workspace as it will display when creating a record or when editing an
existing record on the agent desktop or on the Agent Browser UI.

15. Click Save.
If you save changes to a workspace that sta members are using at the time, they will need to log out and then
log back in to see the changes you have applied.

Best Practices for Creating Workspaces  
When optimized properly, workspaces are extremely exible and useful for achieving a high degree of eciency for sta
members.

When developing custom workspaces for your site, keep the following best practices in mind.

• Design for appropriate screen resolution—Be sure to tailor workspace layouts to your agents’ screen resolution.
If your display is set to a higher resolution than that of the people who will use your workspace, they may nd
that the layout is dicult to use. Test appropriately when making design changes such as adding a column or
adjusting the size of a eld or add-in control.

• Optimize your layouts—Give careful thought to the number and sequence of controls and elds in the layout of
workspaces and tabs, providing only the information, elds, and controls sta members need to do their job.
Also, try to avoid nesting tab sets, panels, and tables more than two or three levels deep. Streamlined layouts
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can optimize workspace performance and improve sta eciency. They are also much easier to update as new
processes are rolled out to your team.

• Add shortcut keys and tab indexes—Agents can be more ecient when they can keep their ngers on the
keyboard. After you have optimized your workspace layout, select a Tab Order option to specify the order in
which eld focus is advanced when the Tab key is pressed, such as top-to-boom or left-to-right (see the Tab
Order buon description at Behavior Properties). Add shortcut keys to the most commonly accessed elds
to provide even faster navigation, and train your team to use them (see the Text label description of Label
Properties).

• Hide or require elds—Reduce visual cluer and improve performance by making elds visible only when they
need to be, and only to agents who need access to them. For example, some elds might be required only when
a new record is being created, and then hidden or displayed in a read-only format the rest of the time. When a
workspace is shared by multiple proles, you can choose to hide some of your elds from proles of agents that
don’t use them. For proles of agents that must complete a specic eld, you can make that eld required for
that specic prole. See How You Set Hidden, Required, and Read-Only Properties.

• Use dierent tabs for dierent tasks—Tabs can be used to organize alternate eld layouts tailored to common
tasks. For example, in addition to a base tab containing an incident discussion thread, you could create another
tab containing a guided assistance control and elds commonly used to solve technical issues. Additional tabs
could contain alternate layouts for resolving billing issues, tracking and returning orders, soliciting feedback, or
creating sales opportunities. Whatever content you add, be sure each tab and eld has an accurate, descriptive
label. Also, be sure to order the tab set appropriately based on priority, with the most frequently used tabs rst.
Then set tab indexes and dene shortcut keys so your agents can navigate quickly using their keyboard. See
Add Tabs to the Design Space.

• Delay loading data-heavy controls—Some controls, such as reports and browsers, may take awhile to load
based on the amount of data they return. To reduce the initial load time of your workspace, you can delay the
loading of these controls when they are located on tabs that are not visible when the workspace is initially
opened. See Report Properties and Workspace and Script Browser Controls.

• Use scripts and workows to simplify your workspaces—Scripts and desktop workows can be eective
alternatives for complex workspaces. A workspace laden with a large number of elds, controls, and rules
can be challenging to create, use, and maintain. By spliing up some of those processes across multiple
elements, you can reduce the risk of functional or procedural conicts while also simplifying and improving
the performance of the interface for your agents. See Overview of Agent Scripts and Overview of Desktop
Workows.

Tip:  For best practices for mapping the agent desktop to your business processes, see  Best Practices for
Implementing Contact Center Experiences .

Workspace Rules  
The eciency provided by custom workspaces can be extended even further using workspace rules.

Note:  Workspace rules are not available for multi-edit workspaces.
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Workspace rules are an automation layer used to set properties for dierent workspace items based on actions and
conditions occurring in the workspace. Workspace rules can save your agents a lot of time by simplifying or completely
automating routine tasks. For example:

• If your workspace contains a lot of elds and controls, you can use rules to show only the information that is
relevant based on the type of interaction, the data being entered, or the identity of the contact or agent.

• If a specic tab on the workspace correlates to a specic incident category, you could add a rule that focuses a
specic tab based on the category value when the editor loads.

• If agents are required to select from a certain subset of dispositions when solving incidents, you could create
a workspace rule to make the Disposition eld required and hide several of its items when incidents are set to
Solved.

• If incidents are escalated among groups based on product and prole, you could add a rule that sets the
Assigned eld to a specic group based on the product value selected and the prole of the logged-in sta
member when a certain buon control is clicked.

With every few clicks you save your agents, you help them become more ecient. Over time, automating your most
repetitive tasks can help your team avoid distraction and beer focus on the task at hand—assisting your customers.

Related Topics
• Workspace and Script Fields

• Workspace and Script Controls

• Field and Control Properties

• Overview of the Dynamic Agent Desktop

Overview of Workspace Rules  
With workspace rules, you can dynamically adjust the display, behavior, and values of elds and controls on a workspace
based on sta member actions. (Workspace rules are not available for multi-edit workspaces.)

Workspace rules are created and managed on the Service Console for sta actions taken on the agent desktop and the
Agent Browser UI. However, not all workspace rule elements are supported on the Agent Browser UI.

Each rule is triggered by one or more events and conditions you dene, and can result in one or more actions, including
the following.

• Set the value of a eld

• Set the required status of a eld

• Make a eld or control read-only

• Show or hide a eld or control

• Show only a select group of menu items

• Open a guided assistance guide (if Guided Assistance is enabled). The Guided Assistance relationship item is
not currently supported on the Agent Browser UI.

• Open a specic script (if Agent Scripting is enabled).

• Create a named event to trigger another workspace rule or a script rule

In simplest terms, a workspace rule is basically a “when-then” statement you use to control the behavior of elds and
controls on your workspace, such as:

• When the status is changed, then make the Product eld required.

• When the disposition is changed, then make the Status eld noneditable.
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At a basic level, each rule denes a triggering event and a resulting action that will occur after the event is triggered.
In some cases, you may nd that the triggers available for rules are not precise enough to address a specic business
need. You can make a rule more restrictive by adding conditions under which the event will trigger an action. If
conditions are specied in a rule, actions will be triggered only if those conditions are met. For example, your rule could
state that when a buon is clicked, if the status is Unresolved, assign the record to the logged-in sta member. The
buon click is the triggering event, but the Unresolved status is the condition under which that event will trigger the
action after the buon is clicked.

There are two types of actions: Then and Else. Every rule has at least one Then action, which is the result of the
triggering event and conditions. However, after conditions are specied for a rule, you can also add one or more Else
actions. An Else action is triggered in cases where the rule conditions are not met. For example, a rule could state
that when the status changes, if the value of the status is Solved, make the Disposition eld editable, or else make the
Assigned eld editable. In this case, when the rule is evaluated, the Assigned eld will be made editable if the record
status has not been set to Solved.

CAUTION:  Since business rules are checked after workspace rules, changes made to a record by workspace
rules can be overridden by business rules if the rules have similar actions.

Workspace rules can be created and managed from two locations on the workspace designer ribbon. Clicking Rules on
the Home tab gives you an overview of all the rules for the workspace. This is helpful if you need a quick look at all the
rules that impact the workspace behavior. You can also add, edit, delete, and order all the rules on the workspace from
this location. If you want to know which rules are associated with a specic eld on your workspace, you can select the
eld on the design space, then click the Rules tab to view a ltered list.

The Rules buon and Rules tab are available only when workspace rules are enabled. For information about enabling
workspace rules, contact your Oracle account manager.

Workspace Rules Tab  
As with the Rules buon on the Home tab, you can also view, add, edit, delete, and order any of the rules from the Rules
tab.

Field Description

Current Selection Click this drop-down menu to view a hierarchical listing of all the items on the workspace design space.
Selecting an item from the hierarchy will select it on the design space.
 

Show Details Click this buon to view the properties of the selected item.
 

Delete Click this buon to remove the selected item from the workspace.
 

Contextual Buon One or more contextual buons may also display in the Selected Object buon group, depending on
the item selected. Click these buons to modify item properties based on the selected item.
 

Add Rule Click this buon to open the Rule Wizard where you can add a rule.
 

Filter List Click this buon to lter the visibility of rules in the list.
 

Rules Triggered by this Object Click this buon to list only rules that use the selected item in the rule triggers.
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Field Description

Rules that Reference this Object Click this buon to list only rules that use the selected item in the rule triggers, conditions, Then
actions, or Else actions.
 

All Workspace Rules Click this buon to list all rules congured for the workspace.
 

Rule List This area lists the rules that match the lter selected from the Filter List buon.
 
You can scroll the rule list using the up and down arrows on the scroll bar. You can expand the list by
clicking the Expand Fields buon at the boom of the scroll bar.
 

Edit Rule Select a rule in the rule list and click this buon to edit the rule.
 

Delete Rule Select a rule in the rule list and click this buon to delete the rule.
 

Move Up Select a rule in the rule list and click this buon to move the rule up one position in the list to reorder
the rules.
 
Rules with the same trigger run in the order listed.
 

Move Down Select a rule in the rule list and click this buon to move the rule down one position in the list to reorder
the rules.
 
Rules with the same trigger run in the order listed.
 

Add a Workspace Rule  
You create rules using the Rule Wizard, which you can open from the Rules tab or from the Rules buon on the Home
tab.

With some exceptions, the method used to create workspace rules is the same as that used to create script rules. The
procedures to create rules from the Rule Wizard can also be used when creating script rules.

1. On the open workspace, click the Home tab and click Rules to open the Rules window.
2. Click Add Rule. The Rule Wizard opens.

The top of the wizard displays ve buons—Triggers, Conditions, Then Actions, Else Actions, and Properties.
You can create the rule by clicking each buon and adding items to the rule description.

3. Select one or more triggers to re the rule.
4. Click Conditions to add conditions that determine whether the triggering event will result in an action.
5. Click Then Actions to dene the actions that should occur if the conditions are met.
6. Click Else Actions to dene the actions that should occur if the conditions are not met.
7. Click Properties and type the name of the rule in the Rule Name eld.
8. Enter any notes you want to add to the rule in the Notes eld.
9. To deactivate the rule, clear the Active check box.

10. Click Finish.
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Related Topics
• Workspace Rule Triggers

• Workspace Rule Conditions

• Workspace Rule Actions

Workspace Rule Triggers  
Rule triggers are events that occur in a workspace that cause a rule to be evaluated. If you add more than one trigger to
the rule description, the rule will be evaluated after any of the selected triggers occur.

Designing for eciency—To best support the maintenance and performance of your workspaces as they grow and
change over time, always try to construct workspace rules that are scalable and suited to the need at hand. For example,
rather than seing up a rule that hides a tab on a workspace when the editor loads, you might simply edit the workspace
itself and set the tab to be hidden by default. Rule actions that are triggered unconditionally when “The editor loads”
can be eliminated by simply having the workspace default to the desired state, which is more ecient for your system to
perform.

Workspace Rule Triggers Description  
Available triggers vary based on the elds and controls that have been added to the workspace.

All rule triggers listed in this table are supported in the Service Console and on the Agent Browser UI.

Event Description

The editor loads
 

Add this event to trigger the rule immediately after a record is opened using the workspace.
 
When using this trigger, rule conditions are evaluated at the time the record is opened. If any of the
conditions require that items be changed after the record is opened, the rule will not re.
 

The record is saved without closing
 

Add this event to trigger the rule immediately after a record is saved without being closed. For
example, you could have a rule that runs when a sta member clicks the Save buon instead of Save
and Close.
 
This event does not aect records which are closed when saved or without being saved. This trigger
should not be used as a last check before the record is saved, since it changes the values displayed in
the workspace after the save occurs, not before.
 

A eld changes
 

Add this event to trigger the rule immediately after the value of a eld is changed. When added, click
the underlined text to select a eld that will trigger the rule. Available elds vary depending on the type
of workspace you are editing. For example, when creating a rule on an incident workspace, you can
select elds from the incidents, contacts, and organizations tables. However, not every eld in these
tables is available for use in workspace rules.
 
When using this trigger, the rule is evaluated at the time any change is made to the selected eld. If the
selected eld is a text eld, the rule will be evaluated the moment any character in the eld is changed.
 
If the selected eld is a currency, the rule will be evaluated when the eld loses focus.
 
Not all elds are supported on the Agent Browser UI.
 

An input control value changes
 

Add this event to trigger the rule immediately after the value of an input control is changed to another
value or to no value. When added, click the underlined text to select an input control that will trigger
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Event Description

the rule. Available input controls include any menus, options, list boxes, and text boxes that are not
used to trigger other rules.
 
This event is available only when an input control has been added to the workspace. When using this
trigger, the rule is evaluated immediately after any change is made to the input control. If you want to
verify that a specic value was selected, add An Input Control Has a Certain Value as a condition.
 

A buon is clicked
 

Add this event to trigger the rule immediately after a buon on the workspace is clicked. When added,
 click the underlined text to select a buon from the workspace that will trigger the rule.
 
This trigger is available only when a buon has been added to the workspace.
 

An image is clicked
 

Add this event to trigger the rule immediately after an image is clicked. When added, click the
underlined text to select an image from the workspace that will trigger the rule.
 
This trigger is available only when an image has been added to the workspace.
 

A hyperlink control is clicked
 

Add this event to trigger the rule immediately after a hyperlink is clicked. When added, click the
underlined text to select a link from the workspace that will trigger the rule.
 
This trigger is available only when a hyperlink has been added to the workspace.
 

The exit script event res
 

Add this event to trigger the rule immediately after the Exit buon is clicked, or when an exit script
event is red by a rule in a script placed on the workspace. Rule conditions are evaluated at the time
that the event is red.
 

The nish script event res
 

Add this event to trigger the rule immediately after the Finish buon is clicked, or when a nish script
event is red by a rule in a script placed on the workspace. Rule conditions are evaluated at the time
that the event is red.
 

The guide nished
 

Add this event to trigger the rule immediately after the Finish buon is clicked in a Guided Assistance
relationship item indicating that a sta member has nished using a guide.
 
This trigger is available only when the Guided Assistance relationship item has been added to the
workspace.
 

An input control value is selected
 

Add this event to trigger the rule immediately after an input control value is selected. When added,
 click the underlined text to select an input control that will trigger the rule. Available input controls
include any menus, options, and list boxes that are not used to trigger other rules.
 
This event is available only when an input control has been added to the workspace. When using this
trigger, the rule is evaluated at the time a value is selected from the input control. If you want to verify
that a specic value was selected, add An Input Control Has a Certain Value as a condition.
 

A named event res
 

Add this event to trigger the rule immediately after a named event is red by another rule on the
workspace or by a rule in a script placed on the workspace. When added, click the underlined text to
enter the name of the event that will trigger the rule. Rule conditions are evaluated at the time that the
event is red.
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Add a Workspace Rule Trigger  
The following procedure describes how to add a rule trigger to a workspace.

1. On the Rule Wizard, click Triggers to list available trigger items.
2. Click Add next to the triggers you want to add to the rule description.
3. If a trigger you have added to the rule description contains underlined text, click the underlined text to specify

the source of the trigger action (such as the eld, control, or event name). See Workspace Rule Triggers for a
description of trigger actions.

4. Do one of the following:

◦ Click Next to add conditions to the rule.

◦ Click Then Actions to add actions to the rule.

◦ Click Finish to save your trigger in the rule.

Workspace Rule Conditions  
Rule conditions are additional criteria that determine whether a rule action will be triggered.

Conditions are evaluated at the time that the trigger event occurs. If all conditions are met (and the logical expression is
valid), the rule Then actions will be taken immediately after the triggering event. If any condition in the rule is not met,
the rule Else actions will be taken. If no Else actions are dened and any condition is not met, no action will be taken.

Workspace Rule Conditions Description  
Available conditions vary based on the elds and controls you have added to the workspace.

All rule conditions listed in this table are supported in the Service Console and on the Agent Browser UI.

Condition Description

The logged in account has a certain value Add this condition to take action based on whether the logged-in account has a certain value. Click the
underlined text to select the account to be evaluated.

The logged in account’s prole has a
certain value

Add this condition to take action based on whether the logged-in account’s prole has a certain value.
Click the underlined text to select the prole to be evaluated.

A new record is being created Add this condition to take action based on whether a new record is being created.

An existing record is being edited Add this condition to take action based on whether an existing record is being edited.

The current editor is a child editor Add this condition to take action based on whether the record is open in a child editor.

The current editor is a primary editor Add this condition to take action based on whether the record is open in a primary (non-child) editor.

The record is copied Add this condition to take action if the record is being copied from another record.

Tip:  This condition can be useful if you want to automatically set eld values when records
are copied.

The record is not copied Add this condition to take action if the record is not being copied from another record.

A eld has a certain value Add this condition to take action based on whether a eld has been set to a specied value. Click the
underlined text to select the eld to be evaluated.

A eld is required Add this condition to take action based on whether a eld is required. Click the underlined text to
select the eld to be evaluated.
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Condition Description

A eld is optional Add this condition to take action based on whether a eld is optional (not required). Click the
underlined text to select the eld to be evaluated.

A eld is read only Add this condition to take action based on whether a eld is read-only. Click the underlined text to
select the eld to be evaluated.

A eld is editable Add this condition to take action based on whether a eld is editable. Click the underlined text to select
the eld to be evaluated.

A eld is hidden Add this condition to take action based on whether a eld is hidden. Click the underlined text to select
the eld to be evaluated.

A eld is visible Add this condition to take action based on whether a eld is visible. Click the underlined text to select
the eld to be evaluated.

An object is read only Add this condition to take action based on whether a control is read-only. Click the underlined text to
select the control to be evaluated.

An object is editable Add this condition to take action based on whether a control is editable. Click the underlined text to
select the control to be evaluated.

An object is hidden Add this condition to take action based on whether a control is hidden. Click the underlined text to
select the control to be evaluated.

An object is visible Add this condition to take action based on whether a control is visible. Click the underlined text to
select the control to be evaluated.

An input control has a certain value Add this condition to take action based on whether an input control has a certain value. Click the
underlined text to dene the input control to be evaluated.

An add-in control condition returns a
certain value

Add this condition to take action based on whether an add-in control returns a certain value. Click the
underlined text to select the add-in control and the parameters to be evaluated.

Add a Workspace Rule Condition  
The following procedure describes how to add a rule condition to a workspace.

1. From the Rule Wizard, click Conditions to list available conditions.
2. Click Add next to the conditions you want to add to the rule.
3. If a condition you have added to the rule description contains underlined text, click the underlined text to open

the Edit Condition window. See Workspace Rule Conditions for a description of rule conditions.
4. To evaluate two or more conditions using a logical expression, click Combine the Conditions Using a Logical

Expression. See Edit a Workspace Rule Logical Expression.
5. Do one of the following:

◦ Click Next to add actions to the rule.

◦ Click Finish to save your condition in the rule.

Workspace Rule Operators  
Operators specify IF conditions in workspace rules.

A workspace rule operator expresses the relationship between a selected eld for a condition and its value, determining
how the eld is applied to the value of the condition. For example, in the condition “If the logged-in account equals
Alex Thompson,” the operator is “equals.” Each eld has its own set of operators, depending on what is logical for that
eld. A workspace rule with the condition “If an answer assignment is greater than or equal to customer support,” for
example, has no relevance and cannot be applied to an answer.
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Operator Description

equals The eld matches the value exactly, including case.

not equals (exclude No Value) The eld does not match the value exactly (excluding case), and does not contain a null value.

not equals (include No Value) The eld does not match the value exactly (including case), or contains a null value.

is null The eld does not contain a value.

is not null The eld contains a value.

in list The eld values you want to search for are specied by selecting check boxes in a menu. The selected
options are displayed in a separate Selected Items list to assist you when selecting from menus with a
large number of options.
 
When using this operator with integer elds, the numbers in the Value eld must be comma-separated.
When using this operator with text elds, the text strings in the Value eld must be comma-separated
and each text string must be oset by single quotes. For example, ‘red’,’green’,’orange’.
Spaces between entries are ignored.
 

not in list The eld values you do not want to search for are specied by selecting check boxes in a menu. The
selected options are displayed in a separate Selected Items list to assist you when selecting from
menus with a large number of options. This operator is available only with menu eld expressions.
 
When using this operator with integer elds, the numbers in the Value eld must be comma-separated.
When using this operator with text elds, the text strings in the Value eld must be comma-separated
and each text string must be oset by single quotes. For example, ‘red’,’green’,’orange’.
Spaces between entries are ignored.
 

less than The eld is less than the value.

less than or equal to The eld is less than or equal to the value.

greater than The eld is greater than the value.

greater than or equal to The eld is greater than or equal to the value.

like The eld matches any part of the value. When using this operator, you should use the % wildcard
symbol to oset your value. For example, to include values that contain “all,” you should type %all% in
the eld.

matches regular expression The eld matches the regular expression entered in a text string value. The regular expression
compiler validates the expression. If an error code is returned, the rule is not saved.

does not match regular expression The eld does not match the regular expression entered in a text string value. The regular expression
compiler validates the expression. If an error code is returned, the rule is not saved.

Edit a Workspace Rule Logical Expression  
When you add multiple conditions to a rule, the conditions are automatically joined together to form a logical
expression.

The logical expression denes how the conditions are evaluated together to determine whether rule actions should be
performed. By default, the logical expression uses Boolean AND logic rather than OR logic. Conditions joined by an AND
operator must all be met for rule actions to be performed. When using the OR operator, any condition can be met.

1. Add more than one condition to the rule.
2. Click Combine the Conditions Using a Logical Expression.
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The Edit Logical Expression window opens. The conditions you added are automatically joined with AND logic
and are displayed in an AND tree node.

3. To add a condition joined with OR logic, click Add OR Node and drag the condition to the OR node.

CAUTION:  Deleting a node from the logical expression will also delete any conditions listed beneath
that node in the tree structure, and there is no Undo option.

When you add nodes to the expression, the nodes are displayed in a tree structure, with conditions displayed
either under an AND node or an OR node. Conditions under the same AND node are joined to each other using
AND logic. Conditions under the same OR node are joined to each other using OR logic. Conditions can be
dragged from one node to another to dene their logical relationships.

4. To delete a node from the logical expression, select the node and click  Delete Node.
5. To view a text denition for the logical expression, click View Text Denition.

a. Click OK.

Workspace Rule Actions  
Immediately after a rule is triggered (and all conditions are met), its actions are performed.

Actions provide a wide array of functions to meet your business needs. They can be used to set the value of a eld or
change its required, read-only, or visibility status. They can set the visibility of controls on the workspace. Actions can
even hide individual items within menus. For example, an action can change the properties of the Status eld to allow
sta members to select from only two of the four incident statuses.

Every rule must have at least one Then action, which is the result of the rule being triggered and its conditions being
met. Else actions can be added if conditions have been dened in the rule. Else actions can use any of the same actions
as Then actions, except they are performed when the rule conditions are not met. For a list of available workspace rule
actions, see Workspace Rule Actions Description.

Note:  If a rule action triggers a connector in a desktop workow, the workow will advance to the next
element without running any subsequent rules in the workspace. See Add a Connector Event.

Workspace Rule Actions Description  
The available rule actions depend on the type of workspace and the elds and controls you have added and are
described in the following table.

All rule actions listed in this table are supported in the Service Console and on the Agent Browser User Interface.

Action Description

Set the value of a eld
 

Add this action and click the underlined text to select a eld and the value you want to set for that eld.
 
In addition to seing an absolute value, you can set relative values for some eld types. Relative values
are dened by adding or subtracting (or appending or prepending) a value to the previous value.
 

Set menu eld to include menu items
 

Add this action and click the underlined text to select items you want to appear in a specied menu
eld.
 
When selecting items in hierarchical menus, you can select the parent item to add the parent and all
child items to the list, or you can select only the child items you want.
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Action Description

Set menu eld to exclude menu items
 

Add this action and click the underlined text to select items you want to hide from a specied menu
eld.
 

Make a eld required
 

Add this action and click the underlined text to select a eld that you want to require sta members to
complete.
 

Make a eld optional
 

Add this action and click the underlined text to select a eld that you want to be optional (not required)
for sta members to complete.
 

Make a eld read only
 

Add this action and click the underlined text to select a eld that you want to be uneditable by sta
members.
 

Make a eld editable
 

Add this action and click the underlined text to select a eld that you want to be editable by sta
members.
 

Hide eld
 

Add this action and click the underlined text to select a eld that you want to be hidden from sta
members.
 

Show a eld
 

Add this action and click the underlined text to select a eld that you want to be visible to sta
members.
 

Set the value of an input control
 

Add this action and click the underlined text to select an input control and the value you want to set for
that control.
 

Note:  A control with a value that can be changed at runtime must be added to the workspace
for this action to be available on workspaces used on the Agent Browser UI.

Set the URL of a web browser control
 

Add this action and click the underlined text to select a browser control and specify a URL for it to load.
 

Note:  A browser control must be added to the workspace for this action to be available on
workspaces used on the Agent Browser UI.

Assign the value of a text box control to a
eld
 

Add this action and click the underlined text to select a text box control and give its value to a text eld.
 

Note:  A text box control must be added to the workspace for this action to be available on
workspaces used on the Agent Browser UI.

Make an object read only
 

Add this action and click the underlined text to select a control that you want to be uneditable by sta
members.
 

Make an object editable
 

Add this action and click the underlined text to select a control that you want to be editable by sta
members.
 

Hide an object
 

Add this action and click the underlined text to select a control that you want to be hidden from sta
members.
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Action Description

Show an object
 

Add this action and click the underlined text to select a control that you want to be visible to sta
members.
 

Focus a tab
 

Add this action and click the underlined text to select a tab or sub tab that you want to receive focus.
 

Hide a ribbon buon
 

Add this action and click the underlined text to select a buon on the ribbon that you want to be
hidden.
 
When you choose to hide a ribbon buon, all instances of the buon on the workspace ribbon will be
hidden.
 

Show a ribbon buon
 

Add this action and click the underlined text to select a buon on the ribbon that you want to be
visible.
 

Invoke a guide
 

Add this action and click the underlined text to select a guide to display to sta members.
 
This option is available only if guided assistance is enabled on your site.
 

Prompt agent to select a guide
 

Add this action to prompt sta members to select a guide to display.
 
This option is available only if guided assistance is enabled on your site.
 

Prompt agent to search for a guide using a
report
 

Add this action and click the underlined text to select a report and prompt the agent to search for a
guide using the selected report.
 
This option is available only if guided assistance is enabled on your site.
 

Run a script
 

Add this action and click the underlined text to select a script control and the script that you want to
run in it.
 
This option is available only if agent scripting is enabled on your site and you have added a script
control to the workspace.
 

Fire a named event
 

Add this action and click the underlined text to enter the name of an event that you can use to trigger a
script branch, desktop workow connector, or another rule.
 
Named events let you trigger a workspace rule from a script rule or a script rule from a workspace rule.
For example, you could create a script rule to re a named event when a buon control is clicked. You
could then create a workspace rule to set the Status eld to Solved when the named event is red.
 

Execute an editor command
 

Add this action and click the underlined text to select an editor command that you want to run. Any of
the record commands that are available as ribbon buons for the workspace type can be selected, such
as Save, Print, Propose, and Refresh.
 

Execute an add-in action
 

Add this action and click the underlined text to select an add-in action that you want to run.
 

Add standard text to thread
 

Add this action and click the underlined text to select a standard text to insert into an incident thread.
Any standard text that has Rule Text enabled can be inserted as a customer entry, response, or private
note type threads.
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Action Description

The Incident Thread relationship item does not need to be added to the workspace for this action to
occur. However, the new thread entry will not be commied until the incident is saved.
 

Display a message box
 

Add this action and click the underlined text to dene a customized message that will display in a
new window. For example, you can use this action to alert the agent when an incident contains a high
severity issue or is missing important information. You can dene the window title and the text of the
message and select an icon to indicate the message context (none, error, information, question, or
warning).
 

Make the editor read only
 

Add this action to make all content in the editor read-only, preventing further changes from taking
place to the record. For example, you could add this action to prevent agents from making changes to
solved incidents.
 

Add or Edit a Workspace Rule Action  
The following procedure describes how to add or edit a rule action to a workspace.

1. From the Rule Wizard, do one of the following:
◦ Click Then Actions to list available Then actions.

◦ Click Else Actions to list available Else actions.

2. Click Add next to the conditions you want to add to the rule.
3. If the action you have added to the rule description contains underlined text, click the underlined text to open

the Edit Action window. See Workspace Rule Actions for a description of rule actions.
4. To change the order of the actions listed in the rule description, click Change the Order of the Then (or Else)

Actions.
a. Click the action you want to move, then click the up or down arrow to move the action where you want it.
b. Click OK.

5. Click Finish.

Modify Workspace Rules  
After you add rules, you can easily edit them, reorder them, or delete them when they are no longer needed. These
functions can be accessed from both the Rules tab and the Rules buon on the Home tab.

Rules are red in the sequence in which they are listed. Adjusting them can impact how other rules aect the
workspace. For example, if multiple rules set dierent values for the same eld, the eld will be set to the value assigned
by the last rule in the sequence.

1. Do one of the following:
◦ From an open workspace, click the Home tab and then click Rules. The Rules window opens and lists all

workspace rules.
◦ Click an item on the workspace and then click the Rules tab. The rule list displays all rules triggered by

the selected item. (If you want to display the rules that reference the selected item, or all rules in the list,
click Filter List and select the option you want.)

2. In the rule list, select the rule you want to modify.
3. To edit the rule, click Edit Rule.

The Rule Wizard opens. See Adding workspace rules.
4. To copy the rule, click Copy Rule.

The Rule Wizard opens the rule copy where you can make any needed changes to rule. The Copy Rule buon
is available only when modifying rules using the Rules buon on the Home tab. It does not appear on the Rules
tab.
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a. Click Finish to save the rule copy.
5. To change the order of the rule, click the up or down arrow to move the rule where you want it.

CAUTION:  Deleting a rule is permanent and cannot be undone. To ensure that a rule is not needed
before deleting it, you can disable it instead. To disable a rule, click the Rules buon on the Home tab
and clear the Active check box next to the rule.

6. To delete the rule, click Delete Rule.

Considerations for Avoiding Workspace Rule Conicts  
You should understand the sequence in which rules are performed in order to avoid rule conicts.

Note:  Some agent scripting and workspace rule elements are not currently supported on the Agent Browser
UI. Test your workspace rules on the agent desktop (Service Console or Agent Browser UI) used by your sta
members.

Because processes for workspace rules, script rules, script branching rules, and workows are often running at the
same time, care must be taken to ensure that their actions do not conict. For instance, when a script is added to a
workspace, the script rules will be running even when the script does not have focus on the workspace. If a script rule
and a workspace rule are congured to update the same eld, an agent may nd that the eld does not update to
the value they might expect. For this reason, it is helpful to understand the sequence in which rules are performed.
Currently, rules are processed in the following order:

1. Workspace rules
2. Script current page rules
3. Script current page branching logic

If additional scripts appear on the same workspace, processing continues as follows:

1. Script 2 current page rules
2. Script 2 current page branching logic
3. Script 3 current page rules
4. Script 3 current page branching logic

While a large number of rules may be dicult to track, remember that you can avoid most common types of conicts
by limiting the number of rules you create and avoiding overlap in triggers. For example, if a workspace rule and script
rule are both triggered by a change to the Category eld, you will want to make sure that these rules do not act on the
same eld or control (such as trying to set two dierent values for the Product eld). If they must do so, add appropriate
conditions to the rules to narrow their focus and impact.

Since most trigger events are common to workspace rules, script rules, and workow connectors, it is important to try to
minimize or reserve certain types of triggers for certain functions. For example, it is generally best to avoid or minimize
the number of data changed triggers (such as “A eld changes”) in your scripts. This is especially true for the rst page
of scripts, as this page will load when the workspace does and is therefore more likely to run into a conict.

Finally, work performed in the agent desktop is augmented by another feature that is usually thought of as separate
and distinct—the server-side business rules. Don’t forget to consider your existing business rules when designing your
agent desktop, especially those functions most commonly performed by rules, such as changing incident assignment.
And be sure to consider your agent desktop designs when adding new business rules. Tracking functional overlaps
between business rules and your agent desktop is just as important as preventing conicts within the desktop to ensure
expected results.
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Preview a Workspace  
When you are editing a workspace, it can be helpful to preview the workspace to see what it will look like when sta
members use it. This can help you assess whether it meets your needs or if it needs further changes.

The preview feature displays the workspace as it will appear to any sta member who has the same set of
administration permissions as you have. To view the workspace as it will appear to a sta member with dierent
permissions, you must log in using a sta account with the same prole as the sta member.

Note:  As in production, previewed reports used on report controls or relationship items automatically aempt
to lter on the record shown using the workspace to display information related to the record. For this reason,
you should make sure that each report contains at least one lter for the primary identication types for the
workspace type. For example, reports used in incident workspaces should lter on incident (i_id), contact
(c_id), or organization (org_id). If such a lter does not exist, the previewed report could return all records.

1. Do one of the following:

◦ While editing a workspace, click the Home tab.

◦ Right-click a workspace on the Workspaces explorer and select Open.

2. To view the workspace as it will appear to sta members when they add records using this workspace on the
agent desktop, click Preview and select Agent Desktop New.
A preview of the new record opens.

3. To view the workspace as it will appear on the agent desktop with data from a specic record, click Preview and
select Agent Desktop Existing.

a. Enter the record ID number.
b. Click OK.

The record preview opens.
4. To view the workspace as it will appear to sta members when they add records using this workspace on the

Agent Browser UI, click Preview and select Agent Browser UI.
The Preview in Agent Browser UI window opens.

a. To view a new record, click Preview.
You can also click Copy URL to Clipboard, and then paste the URL in a web browser.
A preview of the new record opens on the Agent Browser UI.

b. To view the workspace as it will appear with data from a specic record, enter the incident ID or reference
number and click Preview.
You can also click Copy URL to Clipboard, and then paste the URL in a web browser.

c. Click X.

Note:  If you are not already logged in to the Agent Browser UI, you will be prompted to log in before
the preview opens on the Agent Browser UI.

5. To view a chat workspace as it will appear with data from a specic chat session, click Preview.
a. Enter the chat session ID. (Chat session IDs can be found on the tab of an agent’s active chat session as

well as the All Chats report.)
b. Click OK.

The chat preview opens.
6. Click X on the top right or press Esc.
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When you click Preview on a multi-edit workspace, the workspace displays without any record data. You cannot
enter a reference or ID number to view existing data as you can when you select Opening a Record on a single-
record workspace.

How You Export and Import Workspaces  
Administrators can spend a lot of time creating and optimizing custom workspaces to support complex business
processes. However, because workspaces are often comprised of elds and controls that are unique to the interface in
which they were created, they cannot simply be copied between interfaces.

To save time when creating workspaces in multiple interfaces, Oracle Service Cloud lets you export a workspace as an
XML le containing descriptions of all the workspace elements, including elds, controls, layout, and rules. The XML
le can then be used by the import wizard to import the workspace to another interface. The export/import features
can help you migrate a workspace eciently while accounting for elds and controls that are not congured identically
between interfaces. This is helpful if you have a custom workspace you like on one Oracle Service Cloud interface and
want to create a copy or similar workspace on a dierent interface.

Consider the following when exporting or importing workspaces.

• Workspace notes are not included when exporting a workspace to an XML le.

• When a workspace is exported as an XML le, the le includes a hash value that will be used when the le
is imported to determine if the le has been modied externally. If the le has been modied, it will not be
available for importing, and an error message noties you that the le is invalid.

• The XML le can be no larger than 1 MB.

Export a Workspace  
This procedure describes the steps to export a workspace.

1. On the Workspaces explorer, right-click the workspace you want to export and select Open.
The workspace opens.

2. Click File and select Export Workspace.
The Save As window opens.

3. Select the directory where you want to save the workspace denition le and enter the le name.
4. Click Save.

Import a Workspace  
This procedure describes how to import a workspace.

1. From the Workspaces explorer, click New. (If workows are enabled, the buon will be labeled New Workspace.)
The New Workspace window opens.

2. Click Import Workspace from an Exported Workspace File to open the Import Workspace wizard.
3. Click Next.
4. Do one of the following:

◦ Enter the full path of the workspace denition le you want to import.

◦ Click Browse to nd the le on your workstation and click Open.

5. Click Next.
6. To map the le to a workspace type, click the Map To Type drop-down menu and select the record type you

want to map the workspace to. By default, the imported workspace is mapped to the same workspace type as
the original workspace.
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Note:  If items from the workspace you are importing are not used by the workspace type you are
converting it to, the next window lists these invalid items and informs you that they will be replaced by
spacers, eld placeholders, or removed from the imported workspace. Since most database elds and
workspace controls are not shared by workspace types, the majority of elds and controls will often
not be included in the new workspace when you convert the type. However, this option is helpful if you
want to import the general layout from a workspace with a dierent type.

7. Click Next.
8. If the workspace includes records from a custom object, click the Map To Record Type drop-down menu and

select the record type you want to map the records to. If Oracle Service Cloud detects a record type of the same
name already in the site, it is selected by default.

9. Click Next.
10. Click Finish.

The workspace designer opens with the imported workspace. Any elds on the workspace that do not exist on
the site you are importing the workspace into will be indicated as unavailable.

11. Edit the workspace to remove or replace elds that are not available. See Edit a Workspace.
12. Click Save.

When you save a workspace, reports that are used by the workspace report controls will be checked to ensure
they exist on the site. If a report does not exist, a message will be placed in the control stating the report is no
longer available. You can save a workspace that has invalid reports, but you will need to select new reports for
the controls before they can be used by the workspace.

Guided Assistance  

Overview of Guided Assistance  
Guided assistance gives agents and customers the ability to locate answers or text explanations by selecting responses
from question branches in guides. This lets agents quickly nd information they can provide to customers when
working with them on the phone, when responding to an incident, or when chaing.

In addition, guides can be embedded in answers so customers can use them on the customer portal. See Overview of
Answers and Overview of the Answer and Question Details Pages.

Note:  Many factors control answer visibility. For instance, if an answer or section of an answer is available only
to customers whose SLAs give them permission to view certain answer access levels, that answer will not be
visible to customers without that SLA even if they click an answer in a guide. See Overview of Answers.

Not all guided assistance features are currently supported on the Agent Browser UI. For a complete list of supported
features, see Answer ID 9022 on our support site.

To understand how guides can best be implemented in your agent desktop on the Service Console and the Agent
Browser UI, you should also become familiar with workspaces, scripts, script rules, and workows. For a summary of
these features, see Overview of the Dynamic Agent Desktop.
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Provide Guided Assistance to Agents and Customers  
You can create as many guided assistance guides as you need to help your agents and customers locate appropriate
responses to questions related to dierent topics.

You can create guides to help agents answer questions about dierent products and other guides to help answer
questions about service plans. Each guide can include multiple question branches, so you can use a single guide to lead
agents to answers regarding dierent models of a product or multiple service plans.

Note:  These conguration options will not be available until guided assistance is enabled. To enable guided
assistance, contact your Oracle account manager.

1. Add the Guided Assistance explorer to your conguration list for the Conguration buon. See Create a
Navigation Set for the Administrator.

2. Assign guided assistance permission to proles. See Assign Guided Assistance Permission to Proles.
3. Create guides for your agents or customers. See Create or Edit a Guide.
4. To display a guide to agents, add the Guided Assistance control to a workspace selected in the agent proles.

See Guided Assistance Relationship Item.
5. To display a guide to customers, add the GuidedAssistant widget to the customer portal. See Overview of the

Answer and Question Details Pages.

Assign Guided Assistance Permission to Proles  
You rst need to edit your prole to include permission to create guides. Sta members with appropriate prole
permission can create, copy, delete, and rename guides from the Guided Assistance explorer.

Guided assistance permission is not available on the Proles editor unless guided assistance is enabled on your site. To
enable guided assistance, contact your Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The Proles report displays on the content pane.
3. Right-click a prole and select Open.

The Proles editor displays on the content pane.
4. Click Permissions.
5. Click the Service tab and select the Guided Assistance – Add/Edit check box under More Options.
6. Click Save.

Sta associated with the prole you have edited must log out of Oracle Service Cloud and log back in to apply
the changes you have made.

Related Topics
• Add or Edit a Prole

Create or Edit a Guide  
The Guided Assistance explorer provides all the tools you need to manage the guides you create.
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You can copy and delete guides and organize them in custom folders in the same way you work with items in any
explorer. See Open the Reports Explorer.

CAUTION:  If you aempt to delete a guide that is being used in another guide, a dependency warning will
list each location where the guide is used and provide you with an option to cancel the deletion. If you choose
to continue deleting the guide, all references to the guide will be invalidated and you will need to manually
update each reference to either remove it or replace it with a valid guide.

To more easily see relationships between guided assistance questions and responses, view the data in a tree format.
See Overview of Managing Reports on the Reports Explorer.

1. Click Conguration on the navigation pane.
2. Double-click Guided Assistance Explorer in the conguration list.

The Guided Assistance explorer opens on the content pane.
3. To create a new guide, do one of the following:

◦ Click New on the Guided Assistance explorer ribbon. The guided assistance designer opens.

◦ If your navigation set is congured to add guides from the application menu, click File and select Guided
Assistance Guide.

When creating a guide, you add questions to the guide, add text for the question responses, and associate
answers or text explanations with each response. You can also insert existing guides into other guides if you
have a set of common questions and answers you want to use in multiple guides.

4. To edit an existing guide, right-click the guide in the list and select Open.
The buons on the designer ribbon give you access to all the tools you need to preview, validate, and edit a
guide.

Group/Buon Description

Guide Actions and Properties The buons in this group let you preview the guide you create, validate the guide to
ensure it is complete, create answers to add to the guide, add a note to the guide, and
select a language for the guide.
 

Preview
 

Click this drop-down menu and select Agent Preview or Web Preview.
 
If you click on answers while testing a guide, hits will be recorded to the clickstreams
table.
 

Agent Preview
 

Select this option to open a window displaying the guide as it will appear on the agent
desktop.
 

Web Preview
 

Select this option to open a window displaying the guide as it will appear on the
customer portal.
 

Validate
 

Click this buon to verify that all the question branches in the guide are associated with
answers or text explanations.
 
You can save a guide that cannot be validated, but we recommend that you correct all
errors before using the guide.
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Group/Buon Description

 

Create Answer
 

Click this buon to create a new answer associated with the guide. (That is, the guide
is automatically selected in the Guided Assistance eld on the answer.) When sta
members search for guides, a search that matches the associated answer content will
return the guide. See Guide Search Options and How You Add Answers for Multiple
Interfaces.
 

Audit Log
 

Click this buon to open the audit log for the guide, which shows you when the guide
was created and edited, and by whom.
 

Notes
 

Click this buon to open a text window where you can enter notes for the guide. The
notes can be used to explain the purpose of the guide or relay other information to
agents using the guide.
 

Language
 

Click this buon to select the language to use for the guide. Only languages deployed to
your site are available.
 
This buon does not display if your site uses a single language.
 

Add The buons in this group let you add questions, responses, answers, text explanations,
 and other guides to the guide you are creating.
 
Some of the options available in this group are also available when you right-click a
question or response in the guide.
 

Yes/No Question
 

Click this buon to add a question with two responses. The text in the responses reads
Yes and No, but you can change the text as necessary.
 

Buon Question
 

Click this buon to add a question with responses shown on buons.
 

Menu Question
 

Click this buon to add a question with responses shown in a drop-down menu.
 

List Question
 

Click this buon to add a question with responses shown in a list.
 

Radio Question
 

Click this buon to add a question with responses shown with options.
 

Link Question
 

Click this buon to add a question with responses shown as links.
 
To add links to other websites, you must right-click a response and select Call URL. After
typing the URL, double-click it to open the Edit Call URL Properties window. Next to the
Parameter Pass Method eld, select Post and click OK.
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Group/Buon Description

 

Text Question
 

Click this buon to add a question with a response shown as a text box and an OK
buon.
 
All text elds are automatically marked as required on the customer portal.
 

Image Question
 

Click this buon to add a question with responses shown as clickable images. Using the
Client Workow Images explorer, you can add images to use in guides. When you open
the explorer, you can manage images the same way you do in the Images explorer. See
Images Explorer.
 

Response
 

Click this buon to add an additional response to any of the questions you have added
to the guide.
 

Associated Answer
 

Click this buon to open a search window to search for or select an answer to associate
with the selected response. Each response can be associated with multiple answers.
 

Text Explanation
 

Click this buon to add a text explanation to the selected question response. Use text
explanations when you do not have an answer to associate with the response and do
not want to create an answer for the purpose.
 

Fire Named Event
 

Click this buon to add a named event that will re when the response is selected. See
How Events are Used in Workspace and Script Rules.
 

Guide
 

Click this buon to associate another guide with the selected response in the guide you
are creating. For example, you can create a smaller guide used for a number of purposes
and then add it to a larger guide with a more specic purpose.
 

Call URL
 

Click this buon to add an external URL that is called when the response is selected. You
can right-click the Call URL node and select Edit to specify the URL and preview it in a
browser. You can also select a parameter pass method (get or post) and view all name-
value pairs that will be passed to the URL as parameters. See How You Pass Parameters
Through Call URL Nodes.
 

Tip:  Following a Call URL node can be unseling to customers if they do
not expect to leave the guide. To avoid confusion, you can open the URL in a
separate window by editing the answer details page on the customer portal.
See Open Guides in a Separate Window . Otherwise, be sure that the text of the
question or response containing each Call URL node indicates the action that
will result when the option is selected.

Call URL nodes support both absolute and relative URLs. For example, you can post the
relative URL /app/ask to load your Ask a Question page.
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Group/Buon Description

 

Node Properties and Actions The buons in this group let you add text, images, and web pages to questions. You
can also edit, delete, and export questions and all the items in the branches for each
question.
 
Some of the options available in this group are also available when you right-click a
question or response in the guide.
 

Text
 

Click this buon to edit the text for the selected question or response.
 

Agent Text
 

Click this buon to add explanatory text to the selected question. The agent text is
displayed beneath the question and is visible only to the sta members who is using the
guide.
 

Display Type
 

Click this buon to change the question type for the selected question. You can change
the question type to Buon, Menu, List, Radio, Link, Text, or Image.
 

Question Name
 

Click this buon to add a name for the question, which is used to display the question
in the designer and when passing the question as a parameter name to an external URL
(Call URL node).
 

Response Value
 

Click this buon to set the value for the response, which is used when passing the
response as a parameter value to an external URL (Call URL node).
 

Delete
 

CAUTION:  When deleting a question or response, all the images, web pages,
 questions, and responses beneath the item will also be deleted.

Click this buon to delete the selected question or response.
 

Edit
 

Click this buon to open the Edit Question Properties window to change the properties
of the selected question. You can also change the question properties from the ribbon.
See Add Questions and Responses to a Guide.
 
In addition, you can select an answer associated with a question response, and then
click this buon to open a search window to nd a dierent answer to associate with the
response. See Add Questions and Responses to a Guide.
 

Extract
 

Click this buon to open the Extract Guide window where you can copy the selected
question branch to a new guide or to an XML le.
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Add Questions and Responses to a Guide  
The questions you add to guides can be simple or complex.

If you think your agents may need additional context to beer understand a question, you can add a web page or an
image that will appear with the question text. See Add an Image Control to a Workspace or Script.

You can also save time by inserting the content from another guide into the guide you are creating. Inserting guides can
save time if you have a number of common questions, responses, and answers that are used throughout a number of
guides.

Tip:  When editing a guide, you can press Ctrl+F to search for specic text on the content pane. This can be
helpful for locating descriptions or answer IDs referenced within a guide.

1. Select a question type buon on the ribbon to add the rst question to the new guide. For a description of the
question types, see the Guided Assistance Designer Ribbon table in Create or Edit a Guide.
After you add a question, the designer displays the question and its responses using default text. The question
is added with the default text selected for editing.

2. Double-click the text for the question.
The Edit Question Properties window opens.

3. Enter eld information.

Field Description

Question Name
 

Enter a question name to be used as the name of the parameter to be passed to a URL
as dened in a Call URL node. This eld is associated with the Question Name buon on
the ribbon.
 

Question
 

Enter the question to display in the guide. This section contains an HTML editor and
toolbox to help create guides. The HTML editor and toolbox are similar to the editor and
toolbox used for answers. See Adding HTML answers.
 
When inserting an image from the toolbox, you must select a client workow image and
choose to display it either inline (in the body of the answer) or in a window. See Add an
Image Control to a Workspace or Script and Conguring the GuidedAssistant widget.
 
When inserting an inline web page from the toolbox, you must specify the URL address,
 width, and height.
 

Agent Text
 

Enter an internal note to further explain the logic in the question. This text will not
display in guides and is available only to sta members. This eld is associated with the
Agent Text buon on the ribbon.
 

Question Responses
 

Displays all question responses that are associated with the question being edited.
Responses can be added, edited, and deleted. In addition, a display type can be set to
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Field Description

change the format of the responses. This eld is associated with the Response Value
buon on the ribbon.
 

Name-Value Pairs
 

Click this section header to display name-value pairs that are associated with the
question. Name-value pairs can be added and deleted and are used in Call URL nodes to
pass parameters for integration purposes. See How You Pass Parameters Through Call
URL Nodes.
 

4. Click OK.
5. To add responses to the question, click Response.

The new response is added to the question.
6. To edit a question response, double-click the response to open the Edit Response Properties window.

a. Enter the text and value for the response.
b. Click OK.

7. To add another question to the guide, select one of the responses in a question you have added and click one
of the question type buons on the ribbon. The designer is updated to display the new question. When agents
use the guide, they will see the new question when they choose the response the new question is branched
from.

8. Click Save on the Quick Access toolbar. The Save As window opens if you have not yet named the guide.

Note:  If there are problems with the guide (that is, if one or more questions are not associated with
an answer or text explanation), a validation message will display the errors. Click Continue to save
the guide or click Cancel to cancel.If problems exist with your guide, we recommend that you x them
before making the guide available to agents.

a. Enter a name for the guide in the Name eld.
b. Click OK.

Associate Answers and Text Explanations with Question
Responses  
For a guide to be valid, all questions in the guide must be associated with responses, and all responses must be
associated with other questions or with one or more public answers or text explanations.

The following procedure explains how to associate answers and text explanations with responses. After a guide has
been saved, you can click Create Answer on the ribbon to create an answer to associate with your guide.

1. To associate an answer with a question response, select the response and click Associated Answer on the
ribbon. The Add or Edit an Answer Node window opens.

a. If you know the ID number of the answer you want, enter it in the Answer ID eld and click Select.
b. To search for an answer, enter search criteria in the elds, click Search, select the answer you want, and

click Select. The window closes and the answer is associated with the response.
2. To change an answer that has been associated with a response, double-click the answer on the guided

assistance designer. The Add or Edit an Answer Node window opens.
a. Select a dierent answer and click Select.

602



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

Tip:  When you edit a guide, you can view the answers associated with responses by right-
clicking an answer and selecting View Answer.

The answer in the guide is replaced with the new answer.
3. To associate a text explanation with a question response, select the response and click Text Explanation on the

ribbon.
a. Enter the text you want for the explanation and press Enter. The explanation displays beneath the

response.
4. To change the text for an explanation already added to the guide, do one of the following:

◦ Select the explanation, click Text on the ribbon, and enter the text you want.

◦ Double-click the explanation and enter the text you want.

a. Enter the text you want and click OK.
If the text explanation exceeds 200 characters, the Edit Node Text window opens when you double-click the
text explanation.

5. Click Validate on the ribbon to verify that each question response is associated with a public answer or a text
explanation. A message opens stating that the guide successfully validated or that it contains errors.

a. Click OK.

Note:  Validation also occurs automatically when saving a guide. If validation errors occur when
saving, you can click Continue on the Validation Results window to save without rst correcting
the errors. However, the guide will not function properly until all validation errors have been
corrected. If problems exist with your guide, it is important to x them before making the guide
available to agents or customers.

6. Click Save on the Quick Access toolbar.

How You Pass Parameters Through Call URL Nodes  
Call URL functions and parameters can route customers to an absolute or relative URL, helping them nd a solution
more quickly.

A Call URL node is used to link a guide response to an absolute or relative URL. For instance, a customer-facing guide
could lead customers to a solution that requires the involvement of support agents. In this case, you could add a Call
URL node to route customers from the guide to your Ask a Question page. This can be done by entering the relative
URL /app/ask in the Call URL properties.

Note:  Following a Call URL node can be unseling to customers if they do not expect to leave the guide. To
avoid confusion, be sure that the text of the question or response preceding each Call URL node indicates the
action that will result when the option is selected.

You can also pass parameters through the Call URL function by dening name-value pairs in the question or response
properties. For example, when linking to the Ask a Question page, you can pass parameters to automatically set values
for elds such as Product, Category, or a custom eld. To accomplish this, you must rst update the question name
to indicate the name of the parameter you want to set. You can then edit the response properties to set the value you
want.

Alternately, you can add name-value pairs to question properties to declare a static parameter. Static parameters are
parameters that are carried through the remaining branches on a guide and are passed through any Call URL function
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that exists in the question subhierarchy. To test Call URL functions and parameters, click the Preview buon and select
an option for previewing your guide.

Pass a Parameter Using Response Properties  
The following procedure describes how to pass a parameter using response properties. This procedure assumes you
have created a guide containing a question and a response with a Call URL node.

1. From the open guide, right-click the question containing the response and Call URL node, and select Edit.
The Edit Question Properties window opens.

2. Enter the name of the parameter you want to pass in the Question Name eld.
If passing a parameter to an Oracle Service Cloud eld, such as a eld on the Ask a Question page, use the
format table.eldname. For example, to pass a parameter to the Products eld, enter incidents.prod. Custom
elds are indicated in the format table.c$eldname, such as incidents.c$priority.

3. In the Question Responses section, select the response containing the Call URL node and click Edit Response.
The Edit Response Properties window opens.

4. Enter the parameter value you want to pass in the Response Value eld.
If passing a parameter to an Oracle Service Cloud eld, be sure to use a value consistent with the purpose and
type for the eld. For example, to set a Yes/No eld, use a response value of 1 for Yes and 0 for No. To pass a
value to the Products eld, you would enter a number or number sequence corresponding to the product ID.

5. Click OK.
6. Click OK.
7. Right-click the Call URL node and select Edit. The Edit Call URL Properties window displays the URL,

parameter pass method, and all name-value pairs that will be passed as parameters.
8. Select a parameter pass method from the Parameter Pass Method eld. Available options include Get and Post.

The Post method must be used when passing parameters to set elds on a page, such as when seing the
Product eld on the Ask a Question page.

9. Click OK.
10. Click Save.

Related Topics
• Create or Edit a Guide

Pass a Static Parameter Using Question Properties  
The following procedure describes how to pass a static parameter using question properties. This procedure assumes
you have created a guide containing a question and a response with a Call URL node.

1. From the open guide, right-click the question you want to declare the static parameter for and select Edit.
The Edit Question Properties window opens.

2. Expand the Name-Value Pairs section and click Add.
3. Enter the name of the parameter in the Name eld.

If passing a parameter to an Oracle Service Cloud eld, such as a eld on the Ask a Question page, use the
format table.eldname. For example, to pass a parameter to the Products eld, enter incidents.prod. Custom
elds are indicated in the format table.c$eldname, such as incidents.c$priority.

4. Enter the parameter value you want to pass in the Value eld.
If passing a parameter to an Oracle Service Cloud eld, be sure to use a value consistent with the purpose and
type for the eld. For example, to set a Yes/No eld, use a response value of 1 for Yes and 0 for No. To pass a
value to the Products eld, you would enter a number or number sequence corresponding to the product ID.

5. Click OK.
6. Right-click the Call URL node and select Edit.
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The Edit Call URL Properties window displays the URL, parameter pass method, and all name-value pairs that
will be passed as parameters.

7. Select a parameter pass method from the Parameter Pass Method eld. Available options include Get and Post.
The Post method must be used when passing parameters to set elds on a page, such as when seing the
Product eld on the Ask a Question page.

8. Click OK.
9. Click Save.

Related Topics
• Create or Edit a Guide

Guide Preview  
You can preview a guide to conrm that it appears and functions as you want it to.

The Preview buon on the ribbon provides two options for previewing guides.

• Agent Preview—This option opens the guide in a separate window and shows you the guide exactly as your
agents will see it, including the slider bar you can expand to view the navigator.

• Web Preview—This option opens the guide in a separate window and shows you the guide as your customers
will see it.

Note:  The Web Preview feature does not include the toolbar that is available on the Agent Preview feature. To
congure display options for guides that are included in answers, see Overview of the Answer and Question
Details Pages.

Use Agent Preview  
The following procedure describes the steps to preview guides using the Agent Preview option.

1. When viewing a guide, click Preview and select Agent Preview.
A window opens, showing only the rst question in the guide.

2. To view the guide contents, respond to the rst question just as you would if you were an agent using the
guide.
Additional questions, responses, answers, and text explanations display as you navigate the guide branches.

3. To view the guide branches, select the Expand Navigator check box at the top of the window.
A panel on the left side of the window displays the guide contents.

4. To quickly view the content under a question or response, select the question or response on the left side of the
window and click Navigate at the top of the window.
The content of the question or response displays on the right.

5. Click OK.

Use Web Preview  
The following procedure describes the steps to preview guides using the Web Preview option.

1. When viewing a guide, click Preview on the ribbon and select Web Preview.
A window opens, showing only the rst question in the guide.

2. To view the guide contents, respond to the rst question just as you would if you were a customer using the
guide.
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Additional questions, responses, answers, and text explanations display as you navigate the guide branches.
3. Click OK.

Guided Assistance Relationship Item  
Before your agents can use guides, you must add the Guided Assistance relationship item to a custom incident or chat
workspace.

When added, the Guided Assistance relationship item functions as a container for displaying guides to your sta on
the agent desktop. Guides can be displayed manually, based on a guide search or selection performed by an agent.
See Guide Search Options. They can also be loaded dynamically, based on a workspace or script rule. For example, you
can design a workspace rule to display a guide automatically when the editor loads based on the incident category, or
you can load a dierent guide when an agent selects a certain incident disposition. See Guided Assistance Functions in
Workspace and Script Rules.

Note:  A separate Guided Assistance eld can be added to answer workspaces and scripts. This eld lets
you associate answers directly to guides for search-matching purposes. See How You Associate Answers to
Guides.Guides can also be embedded in answers so customers can use them on the customer portal. See
Overview of Answers and Overview of the Answer and Question Details Pages.

Related Topics
• Relationship Items

• Overview of Workspace Rules

• Create a Workspace

Guide Search Options  
You can provide your agents with the ability to manually select and display guides on the Guided Assistance relationship
item. When these options are enabled, agents can use a set of buons at the top of the control to search for and select a
guide appropriate for their needs.

Note:  When providing guide search to your agents, you must ensure that each guide is appropriately
associated to one or more answers. See How You Associate Answers to Guides.

Several design options are available for guide searching. By default, the Guided Assistance Search report is used when
performing searches, but you can select a dierent search report to use instead. Also, as an alternative to displaying
the default Search for a Guide and Select a Guide buons, you can display the guide search elds inline at the top of
the control. You can also choose to hide the left navigation page if you want to restrict agents from jumping freely to
dierent sections of the guide.

In addition, when the Guided Assistance relationship item is added to incident workspaces, Guided Assistance is
automatically displayed on the ribbon. By default, this buon provides both select and search options for locating
guides. However, you can edit Guided Assistance to show or hide either option. Or, if you do not want Guided Assistance
to display at all, you can remove it. See Ribbon and Quick Access Toolbar Buons.

Related Topics
• Find Answers Using Guided Assistance
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Edit Guide Search Options  
This procedure describes the steps to edit guide search options.

1. From the Workspaces explorer, right-click the workspace containing the guide you want to edit and select
Open.

2. Select the Guided Assistance relationship item on the workspace.
3. Click the Design tab.
4. Edit the Options buon group properties. See Edit a Field or Control.

Option Description

Search Report
 

Click this buon to select the report you want to use when searching for guides from
a workspace. The report is displayed when you click the Search for a Guide buon on
the guided assistance panel or you click the Guided Assistance buon on the incident
ribbon and select Search. The report is also shown on the guided assistance panel on
the incident workspace when the Show Search Inline option is enabled on the incident
workspace.
 
By default, the standard Guided Assistance Search report is used to search for guides.
We recommend that you do not change the default report unless you require a custom
report with dierent elds.
 

Show Search Inline
 

Selecting this option displays search elds on the guided assistance panel you can use
to search for a guide. The elds that are displayed come from the search report you
select for nding guides.
 
Selecting this option prevents the Search for a Guide and Select a Guide buons from
displaying on the guided assistance panel, though these can still be accessed from the
Guided Assistance buon on the incident workspace ribbon.
 

Show Search Buon
 

This option adds the Search for a Guide buon on the guided assistance panel. Clicking
this buon on a workspace opens the Search for a Guide window where you can enter
search criteria to nd the guide you want.
 
If this check box is not selected on the workspace designer, the Search for a Guide
window can still be opened from the Guided Assistance buon on the incident
workspace ribbon.
 

Show Select Buon
 

This option adds the Select a Guide buon to the guided assistance panel. Clicking this
buon opens the Select a Guide window where you can select the guide you want from
a list of available guides. See Guide Search Options.
 
If this option is disabled, the Select a Guide window can still be opened from the Guided
Assistance buon on the incident workspace ribbon.
 

Show Navigation
 

This option adds the Expand Navigator check box and slider bar to the guided
assistance panel. Clicking this buon on a workspace lets you view all the branches in
the guide simultaneously. See Guide Preview.
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Option Description

 

Edit the Guided Assistance Buon  
The following procedure describes the steps to edit the Guided Assistance buon.

1. From the open incident workspace, click the Home tab and click Ribbon.
2. Select Guided Assistance.
3. Click Edit Buon on the ribbon editor.

The Guided Assistance Buon Editor opens.
4. Select the size and style options you want for the buon.
5. Click the Available Options drop-down menu and select the option you want to display on the buon.

a. Choose Select a Guide if you want only the Select option on the buon. This option opens a window
listing all the guides congured on your site that your agents can select from.

b. Choose Search for a Guide if you want only the Search option on the buon. This option opens the
Search for a Guide window where agents can search for the guide they want using the content from
answers associated with the guide.

c. Choose Both Select and Search for a Guide to show both options on the buon.
6. To change the search report you want to display when the Search option is selected, click Select Search Report

to open the Select Report window.

Note:  By default, the standard Guided Assistance Search report is used to search for guides. We
recommend that you use this report unless you require dierent search options.

a. Select the report you want agents to use to search for guides.
b. Click OK.

7. Click OK to save the changes to Guided Assistance.

Related Topics
• Ribbon and Quick Access Toolbar Buons

• Edit a Field or Control

How You Associate Answers to Guides  
In order for your agents to search for guides eectively, you must understand how guide searching works and manage
your content accordingly.

Because guide content (such as question text) is highly contextual and not wholly descriptive of a topic, it is not indexed
for searching. However, answers associated with each guide are very relevant to searching, so the content of those
answers is indexed. For this reason, when a search is performed, the results are based on the content of associated
answers, not on the content of the guides themselves. For example, searching for the product Phones will return guides
that are associated with answers set to that product.

Therefore, in order for a guide to be searchable, you must associate it to an answer. And so that it can be searched for
intuitively, the answer content must be relevant to the topic addressed by the guide.

There are two ways to associate an answer to a guide.

• How You Find Guides Associated to Answers

• How You Select a Guide from the Answer’s Guided Assistance Field
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Note:  You do not need to associate the answer with a guide if the answer is already associated with a
response in the guide. For procedures detailing how to add elds, controls, and relationship items to
workspaces, and how to create workspace rules, see Overview of Workspaces.

Related Topics
• Associate an Answer with a Guide

How You Find Guides Associated to Answers  
You can associate answers to guides and later nd guides associated to those answers using the Guide Dependency
report.

When editing the Guided Assistance relationship item on a workspace, you can select a response on the guide and
use the Associated Answer buon to associate an answer to it. This creates a natural association because, in this case,
the answer is part of a solution path dened by the guide. See Associate Answers and Text Explanations with Question
Responses.

Tip:  To help you identify guides associated to a particular answer, the Guide Dependency report lists answers
and other guides that have been linked to by each guide. The Guide Dependency report is located in Public
Reports/Service/Guided Assistance on the Reports explorer.

How You Select a Guide from the Guided Assistance Field on an Answer  
You can select a guide from the guided assistance eld by associating a guide using the Guided Assistance eld on an
answer or custom workspace.

Sometimes, a guide may not contain any responses that link to answers from the knowledge base. For example,
responses could be associated only with text explanations. In this case, to make the guide searchable, you must
associate it with an answer using the Guided Assistance eld in the answer editor. On the default answer workspace,
the Guided Assistance eld is located on the Details tab. (For custom workspaces, you can add the answers.guided
assistance eld from the Insert Field ribbon tab on the workspace editor.) For example, if the answer is associated with a
guide named Service Plan Assistance, that guide will be returned in guide searches when the search criteria matches the
answer contents.

Use one of the following reports on the Reports explorer to help you identify guides that will be impacted by changes to
guides or the removal of associated content.

• Public Reports/Service/Guided Assistance/Guide Dependency—Lists answers and other guides that have
been linked to by each guide.

• Public Reports/Service/Guided Assistance/Guided Assistance Search—Lists Guided Assistance guides that
contains the answers matching the specied search criteria.

Related Topics
• Reports Explorer

Associate an Answer with a Guide  
You must associate an answer with a guide in order for the guide to be searchable.

1. With the answer open, navigate to the tab or other location where the Guided Assistance eld is displayed.
In the default answer workspace, this eld is located on the Details tab.

2. Click Select Guide to the right of the eld to open the Select a Guide window.
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3. Select the guide you want to associate the answer with.
4. Click OK to close the Select a Guide window.
5. Click Save.

Related Topics
• Add Answer Details

Guided Assistance Functions in Workspace and Script Rules  
Guided assistance functions are available as triggers and actions when conguring rules for incident and chat
workspaces. For example, you can design a rule on an incident workspace that will open a guide based on the product
or category.

Although the Guided Assistance control is not available for scripts, incident scripts that share a workspace with a Guided
Assistance control can also access these functions. For instance, in a workspace that contains both an incident script
and Guided Assistance control, you can create a script rule that is triggered when the guide is completed. See Script
Rules.

Trigger/Action Description

The guide nished
 

Select this trigger to invoke a rule when a sta member completes a guide in the workspace.
 

Invoke a guide
 

Select this action to choose a specic guide to open. When this operation is selected, you choose the
guide you want from the Value eld on the Add Action window.
 

Prompt agent to select a guide
 

Select this action to display a list of guides to agents. Agents can then choose the guide they want to
use.
 

Prompt agent to search for a guide using a
report
 

Select this action to display a search window where agents can search for a specic guide.
 
By default, the standard Guided Assistance Search report is used. If you want to select a dierent
report, click Select Search Report on the Value eld when this operation is selected.
 

Note:  Guided assistance options are also available when conguring workow connector events leading from
incident elements. See Add a Connector Event.

Related Topics
• Script Rules

• Add a Workspace Rule

• Add a Connector Event

• Add a Connector Condition
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How You Export and Import Guides  
After you create a guide, you can export it to a guide denition le and import it into other Oracle Service Cloud
interfaces to create a new guide. This lets you create a single guide for use in several interfaces.

You can also extract a subset of the guide questions and responses to either create a new guide or save to a guide
denition le that you can then import into another site. This function also includes an option to replace the extracted
branch with an embedded reference to the new guide, which can be useful for simplifying the conguration of a
complex guide.

Export an Entire Guide  
The following procedure describes the steps to export an entire guide.

1. On the Guided Assistance explorer, right-click the guide you want to export and select Open.
The guide opens on the content pane.

2. Click File and select Export Denition from the menu.
The Save As window opens.

3. Select the directory where you want to save the guide denition le and enter the le name.
4. Click Save.

Export Part of a Guide  
The following procedure describes the steps to export a subset of questions and responses for a quide.

1. On the Guided Assistance explorer, right-click the guide you want to extract from and select Open.
The guide opens on the content pane.

2. Right-click the question at the top of the section you want to extract and select Extract.
The Extract Guide window opens. By default, the selected part of the guide will be saved in the Guided
Assistance explorer as a new guide.

a. Enter a name for the new guide.
b. To replace the selected part of the open guide with an embedded reference to the new guide, select the

Replace check box.
3. To export the selected section as a guide denition le, select Export to File.

a. Click Browse and select the location where you want to save the le.
b. Enter a name for the new guide.
c. Click Save.

4. Click Extract.
All responses, answers, and text explanations that are part of the extracted question branch will be included in
the extracted guide.

Import a Guide Denition File  
The following procedure describes the steps to import a guide from other Oracle Service Cloud interfaces.

1. From an open guide on the designer, click File and select Import Denition from the menu.
A message appears indicating that the import process will overwrite the current open guide.

2. Click Yes to allow the import to overwrite the current open guide.
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Note:  Guide denition les include a hash value that is used when the le is imported to determine if
the le has been modied externally. If the le has been modied, it will not be available for importing,
and an error message noties you that the le is invalid.

3. Select the guide denition le containing the guide you want to import and click Open.
The imported guide displays on the content pane.

4. If the guide was exported from a dierent Oracle Service Cloud site, verify that the answers associated with
question responses are correct and choose dierent answers if necessary.

5. Click Save on the Quick Access toolbar. The Save As window opens if you have not yet named the guide.
a. Enter a name for the guide.
b. Click OK.

Agent Scripts  

Overview of Agent Scripts  
Agent scripts in Oracle Service Cloud add powerful functionality to workspaces and workows, leading sta members
through a series of pages to help them enter information in a logical progression.

Script pages can contain most elds and controls available to workspaces, with the exception of relationship items. They
can also include questions and branching logic, similar to guides, so you can create wizards to guide sta members
to dierent pages based on the information entered or actions taken on a previous page. Combining branching logic
with page layout capabilities, agent scripting provides your sta with a methodical, ecient interface for capturing
information and resolving issues.

For example, you could create a script to help your agents identify new customers and prompt for contact information
before entering incident information. The script could also include questions to determine what product the customer is
calling about and branching logic to guide agents to a page containing troubleshooting information and database elds
for capturing information pertinent to that product.

To further extend the eciency provided by scripts, you can add script rules. Like workspace rules, script rules are
triggered by events and conditions to perform actions on script pages, such as seing the value of a eld or calling a
named event.

After you create a script, it can be inserted into one or more workspaces using the Script workspace control (see Add
a Script Control to the Design Space) or presented as a standalone component of a desktop workow using the Script
workow element (see Edit Script Aributes).

Many functions used to design scripts are also used to design workspaces. To understand how agent scripts can best
be implemented in your agent desktop, you should also become familiar with workspaces, workspace rules, guides, and
workows. For a summary of these features, see Overview of the Dynamic Agent Desktop.

Assign Scripts Permission in Proles  
Before you can create or access agent scripts, you rst need to update your prole to include scripting permission.
Sta members with scripting permission included in their prole can create, copy, and delete scripts from the Scripts
explorer, as well as add them to workspaces and workows.
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Scripting permission is not available on the Proles editor unless agent scripting is enabled on your site. To enable agent
scripting, contact your Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Right-click the prole you want to add scripts permission to and select Open.

The Proles editor opens.
4. Click Permissions.
5. Select the Scripting check box on the Administration tab.
6. Click Save.

Note:  Sta associated with the prole you have edited must log out of Oracle Service Cloud and log
back in to apply the changes you have made.

Open the Scripts Explorer  
The Scripts explorer is used to access and manage all of the agent scripts on your site.

With this explorer, you can browse, search, and organize scripts in hierarchical folders on the content pane using
functions similar to Windows Explorer.

Note:  Oracle Service Cloud does not include a set of standard scripts because all scripts are designed with
unique content to meet specic business needs.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Scripts Explorer.

The Scripts explorer opens. The explorer displays the tree structure on the left and lists scripts and custom
folders on the right. Listed next to each script name is its script type, based on the type of record it is used
to update. The script type determines which elds and controls can be added to the script. For example, the
Incident script type provides access to controls and database elds that are related to incidents. See Script
Types.

You can create custom folders to help you organize the scripts you create by right-clicking the Scripts item in the Folders
tree and selecting New Folder. Simply click a folder to display a list of the scripts it contains.

Note:  You can also add the Scripts explorer to any of your navigation lists if your prole allows. See Download
the Oracle Service Cloud Client and Log In.

Script Types  
Each agent script is associated with a script type, named for the type of record it updates, that determines which elds
and controls can be added to the script.

Oracle Service Cloud provides the following standard script types.

• Answer

• Asset
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• Chat

• Contact

• Incident

• Opportunity

• Organization

• Task

In addition, you can create scripts for custom objects that have Object is Available in Workspaces, Scripting, and
Workow eld visibility. See Overview of Custom Objects.

When you create a script, you need to select the type of script you want to ensure the appropriate elds are available
for use in the script and that the script type matches the type of workspace you want to add the script to. For example,
when creating a script to use on an incident workspace, you would select an incident script type, giving you access to
controls and database elds that are related to incidents.

The script types available to you depend on the products that are enabled in your application. For instance, Oracle
RightNow Opportunity Tracking Cloud Service must be enabled in order for the opportunity script type to be available,
and Oracle RightNow Chat Cloud Service must be enabled for the chat script type to be available.

Note:  If you plan to add your script to a workspace, the script type must match the workspace type. However,
there are fewer script types than workspace types because scripts are not available for use in quote, quote
product, or multi-edit workspaces. See Standard Workspaces.

Script Designer  
Scripts are created on a script designer consisting of a design space, a ribbon, and a page selector.

You dene a script by dragging and dropping elds and controls from the ribbon onto the design space and arranging
them as you want them to appear on the script page.

The design space is the working area where you arrange elds and controls as you want them to appear on the script
page. When you create a new script page, the design space consists of three areas—a header and a footer shared by all
pages, and a main area for content specic to the page. You can add elds and controls to any of these areas.

Each area contains a table, hidden by default, that forms an underlying grid for aligning elds and controls. To aid you in
laying out the script page, you can display outlines around items on the design space to help you identify the table cells
they are in. See Design Space Layout Options.

After a eld or control has been added to a page, you can select it to adjust its properties on the designer ribbon.

Tab Description

Home
 

Contains buons for managing the entire script. You can preview the script, add pages and branches,
 congure the ribbon for scripts added to workows, add notes, view the audit log, add an outline
around the script, and show or hide the page selector. The Insert group on the Home tab also includes
shortcuts to the controls you can add from the Insert Control tab.
 

Insert Field
 

Lists the elds you can add to the script. The type of script you select when creating a script
determines the elds available. For example, you can add incident, asset, contact, and organization
elds when creating an incident script. See How Fields Are Added to Workspaces and Scripts.
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Tab Description

 

Insert Control
 

Lists controls and questions you can add to the script. Controls include spacers, tabs, title bars,
 and other items you can use to enhance the display or add functionality. See Workspace and Script
Controls. Questions controls are used to congure script branching. See How Branches Work in Scripts.
 
The values sta members enter in questions and their corresponding controls are available for use with
the script rules and branches, but they are not saved to the record in the database.
 

Page
 

Contains buons for adding, editing, deleting, and ordering pages and branches. This tab also includes
buons to display or hide the header and footer on pages. See How Branches Work in Scripts and Place
the Header on Script Pages.
 

Rules
 

Using the buons on this tab, you can create rules that alter the script according to the conditions you
dene. For example, you can create a rule to assign an incident to a specic sta member when the
incident is submied by a particular organization. See Script Rules.
 

Design
 

This tab displays when you select an item added to a script and contains buons you can use to edit
the display of the selected item. For example, you can change fonts and margins for a eld or set a
eld on the script to read-only if you want to display it only for informational purposes. The options
available on the Design tab vary depending on the control or eld selected on the script design space.
For descriptions of all the options available on the Design tab, see Design Property Descriptions.
 

In addition to editing eld and control properties on the designer ribbon, you can also right-click an item on the design
space to access contextual menu options. The available options vary based on the item you right-click but generally
include such actions as branching to a page, reseing tab indexes, or deleting the item.

When a page is complete, you can use the page selector to add more branches and pages to your script (see How
Branches Work in Scripts). The page selector displays a tree view of the pages and branches of the script, showing their
relationship to one another. You can click a page or branch to view it on the design space or right-click to access a menu
from which you can quickly add, edit, delete, or rename pages and branches. You can also use the arrow keys on your
keyboard to navigate between pages, or delete a page by pressing Delete. Script pages that are inaccessible due to a
removed branch or other reason are also indicated on the page selector.

Tip:  To hide the page selector, click the Home tab, click Page Selector, and select Show Selector to switch it
on or o. You can also select Use Large Icons on Show Selector to switch between using large and small icons
on the page selector.

Create a Script  
The following procedure describes how to create scripts.

You can create scripts from scratch by starting with a blank script. You can also copy an existing script or import a script
from an exported script le to use as the basis for a new script. You can then adjust the design by adding and removing
elds and controls, seing properties, and arranging the layout to suit your business needs.

1. From the Scripts explorer, click New.
A window opens where you can select the type of script you want to create.

2. In the Start With a Blank Script section, select a script type. See Script Types.
The script designer opens.

3. Click Save.
To import a script from an exported script le, see Export a Script.

615



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

Copy a Script  
The following procedure describes how to copy a script.

1. From the Scripts explorer, right-click the script you want to copy and select Copy.
The Copy Script As window opens.

2. Select the folder to which you want to add the copied script.
3. Enter a name for the copied script in the Name eld.
4. Click OK.

The script you added appears in the folder you selected.

Delete a Script  
The following procedure describes how to delete a script.

1. From the Scripts explorer, right-click the script you want to delete and select Delete.
A Conrm Script Deletion message displays.

2. Click Yes to delete the script.

Note:  If you delete a script that is used in a workspace, the workspace will still include the Script
control. You will need to edit the workspace to remove the control or select a new script for the control.
See Add a Script Control to the Design Space.

Edit a Script  
Whether you are editing a blank script or an imported script, the features you use on the script designer are the same.

When creating a new script, the script designer opens with a page already added that contains a header, footer, and text
control. You use the options available on the ribbon tabs to remove or edit this default content, and add elds, controls,
and other pages to the script. If your script is to be used in a workow, you can also customize the script ribbon.
The elds and controls available for a script will vary depending on the type of script you are creating. For example, a
contact script will provide access only to contact and organization elds.

The following procedure provides an overview of the steps needed to edit a blank incident script, though the same
procedures can be used for other script types. Cross-references to more detailed editing procedures are provided in the
appropriate step.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Scripts Explorer.

The Scripts explorer opens on the content pane.
3. Right-click the script you want to edit and select Open.

The script opens on the content pane.
4. Drag the elds you want from the Insert Field tab onto the design space. See Workspace and Script Fields.
5. Drag the controls and questions you want from the Insert Control tab onto the design space. See Workspace

and Script Controls.
You can also drag controls onto the design space using the icons on the Home tab Insert group.

6. To modify the properties of a eld or control, select the item, click the Design tab, and make the appropriate
changes. See Field and Control Properties.

7. To add script rules that alter the display, content, or behavior of items on the page, click the Rules tab and then
click Add Rule. See Script Rules.

8. To add a new page to the script, select the existing page on the page selector that you want the new page
placed after.

a. Click the Home tab and click Add Page.
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The new page is added to the script and displayed on the page selector.
9. To add a branch to the script, select the page you want to add the branch to on the page selector and create

the branch by right-clicking a eld or control or by using the Add Branch window. See How Branches Work in
Scripts.

10. To reposition a page in the script, drag it to the position you want on the page selector.

Tip:  After a page has been moved, logic used in the branches linking the page to other pages may no
longer be valid. We recommend validating the script after moving pages to ensure the script pages can
all be reached.

When you move a page, the page and all pages that branch o it are moved to the location you specify. When
reordering pages, you can move a page that branches o one page to branch o a dierent page, or remove
branching from the page completely.

11. To rename a page, select the page, click the Page tab, enter the name you want in the ribbon Name eld, and
press Enter.

12. To add or remove the header and footer from script pages, click the Page tab, click Header or Footer, and
select the option you want. See Place the Header on Script Pages.

13. To customize the ribbon for a script that is used in a workow, click Ribbon on the Home tab. See Ribbon and
Quick Access Toolbar Buons.
Because ribbons are not displayed on scripts when they are added to workspaces, the Ribbon buon is available
for scripts only if workows are enabled on the site. For information about enabling workows, contact your
Oracle account manager.

14. To view a history of all actions taken on the script, such as when the script was created and edited and by
whom, click Audit Log on the Home tab.

15. To add notes about the script, click the Home tab and then click Notes to open the Script Notes window.
a. Enter any notes you want in the text eld.
b. Click OK.

Notes added to your script are for internal use and only visible when editing the script. They do not
appear when working with records.

16. To see what your script will look like when it is used by sta members, click the Home tab and click Preview.
You can choose to see the script as it will display when creating a record or when editing an existing record. See
Preview a Script.

17. To conrm that the pages are all accessible from a branch or a navigation buon, click the Home tab and click
Validate. The Script Validation Results window will list any inaccessible pages.

a. Click OK.

Note:  Validation is also performed automatically when you save a script. If errors are found, the Script
Validation Results window will include a Cancel buon, so you can correct the error before saving,
and a Continue buon you can click to save the script as it is. You can save and use a script that does
not validate. However, until all errors are corrected, some pages or functions may be inaccessible to
sta members when they use the script.

18. Click Save on the Quick Access toolbar.

If you save changes to a script that sta members might be using at the moment, it is a good idea to have them log out
and then log back in to be sure your changes have been applied.
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Considerations for Removing Items from Scripts  
You can easily remove elds, controls, branches, rules, and entire pages from your script. However, it is important to be
aware of the following considerations before you remove items.

• If your script has only one page, you cannot remove it.

• When you remove a table on a page, the elds and controls on the table are also removed.

• When you remove a page, all elds and controls on the page are removed along with branches and rules
created from the page.

• When you remove a page with other pages branching o it, those pages are also removed.

• When you remove an item used by a rule or branch, the rule or branch will likely be impacted, and you will need
to edit or delete it.

• When you remove a branch used to access a page, the page is not removed. However, this can result in an
orphaned page if the deleted branch provided the only path to the page.

Note:  Pages that cannot be accessed by a branch or navigation buon are grayed out on the page selector.
When you validate the script, these pages are listed in the validation message.

Remove an Item from a Script  
When you are certain you no longer need an item and know how your changes will impact the rest of your script, you
can remove elds, controls, branches, rules, and entire pages from your script.

1. From your open script, do one of the following:

◦ Select the item you want to remove on the design space.

◦ Click the Design tab and select the item you want to remove from the drop-down menu on the Selected
Object group.

Tip:  Selecting the item you want to remove from the drop-down menu helps to ensure that you select
the correct item before you delete it. For example, you can be certain you select a specic eld on a
table rather than the entire table. See Access Design Space Items Using the Ribbon.

a. Click Delete on the Design tab.
The Delete Conrmation window opens, asking if you want to delete the item. If the item you are
deleting is used in rules or branches, a warning will list the aected rules and branches.

b. Click Yes to delete the item.
2. To delete a page or branch, select the item on the page selector and click the Home tab.

a. Click Delete.
The Delete Conrmation window opens, asking if you want to delete the item.

b. Click Yes to delete the item.

Place the Header on Script Pages  
Headers and footers can contain any of the elds or controls you can add to script pages.
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Unlike the content you add to other areas of a page, which is displayed only on that page, the content you add to the
header and footer is shown on every page where the header and footer is displayed. For example, if you want to display
contact information at the top of every page of the script, you could add the rst name, last name, and phone numbers
contact elds to the script header, and then display the header on all pages of the script.

By default, the header that is shown on the initial script page contains the progress label control, which shows sta
members what page of the script they are on. The default footer contains the navigation panel control, which adds
buons sta members can use to move between script pages. See Navigation Panel Control Buons.

The following procedure describes how to place the header on script pages. You use a similar procedure when placing
the footer on script pages.

1. From your open script, click the Page tab.
2. To show the header only on the selected page, click Header and select Show Header On This Page.

The header is added to the page on the design space.
3. To show the header on all pages in the script, click Header and select Show Header On All Pages.
4. To remove the header, click Header and select Don’t Show Header On Any Pages.

The header is removed from all pages in your script, along with any elds or controls you added to the header.
5. To add content to the header or footer, click the Insert Field or Insert Control tab and drag the items you want

to the design space.

Navigation Panel Control Buons  
The navigation panel contains four buons that let you navigate between pages in the script even if there are no
branches to the pages. Some of the buons can be used in the When condition in branches and script rules, so you can
create your own functionality for these buons.

Since these buons are available in a single control, you can quickly add the buons to any page you want. The page
footer contains this control by default. The following buons are included in the control.

• Beginning—Click this buon to return to the rst page of the script.

• Previous—Click this buon to return to the previous page in the script.

• Next—Click this buon to proceed to the next page in the script. By default, this is the next page that is on the
same tree level, shown on the page selector, as the current page. However, a branch can be created to load a
dierent page when this buon is clicked.

• Exit/Finish—Click this buon to trigger any rules or branches that include the Exit Script Event Fires or Finish
Script Event Fires triggers. When you are on the last page of a script, Exit is renamed Finish. This buon is not
enabled unless a rule or branch is congured to use one of these conditions.

How Branches Work in Scripts  
This topic explains adding branches to scripts.

Scripts use branching logic for guiding agents to specic pages based on conditions you specify. For example, you could
design a script to branch to a certain page if the Organization Name eld is set to a specic value. You can also create
branches that are triggered when dierent responses are selected from question controls, such as the Radio Question or
Menu Question controls, or from the Next, Exit, and Finish buons on the navigation panel.
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Branches can be created using dierent methods and simple or complex logic, depending on your needs. After you
create branches, you can easily edit, reorder, and delete them using the tools available on the ribbon.

You can create branches quickly by right-clicking elds and controls on the design space. You can also dene more
complex branches using the Add Branch window. The options on the window are similar to those used to add
workspace or script rules.

Tip:  While you can create branches from most of the controls and elds available for scripts, question
controls are ideal for branching, allowing you to quickly branch to other pages using agents’ responses to the
questions you add to the script.

Add a Branch by Right-Clicking a Field or Control  
When you want to take agents to another page in a script when they change a value in a eld or a control, the easiest
way to create the branch is to right-click the eld or control and create the branch using options on the right-click menu.

1. From your open script, select the page you want to add the branch to on the page selector.
2. Right-click the eld or control on the design space that you want to branch from.

A menu opens showing branching and other options. The branching options vary depending on the item you
select. You can branch from question controls when a specic question choice is selected, and you can branch
from elds and controls when their value changes or when actions are taken, such as when you click a buon
control.

3. To create a branch from a question control, right-click the question control and select the question response
you want to trigger the branch from.

Note:  This step is necessary only when creating a branch from a question control.

4. Select the page you want the branch to go to. The page options vary slightly depending on the item you create
the branch from and which page you are on when you create the branch.

a. To branch to the next page on the same branch level as the current page, select Go to Next Page. This
option does not display when creating a branch on the last page of a script.

b. To branch to the previous page in the script, select Go to Previous Page. The previous page is the page
sta members would visit before the current page when using the script. This option does not display
when creating a branch on the rst page of a script.

c. To branch to an existing page, select Go to Page (or Branch to Existing Page). A window opens where
you can select the page you want to branch to.

d. To branch to a new page, select Go to New Branch Page (or Branch to New Page). A new page is created
and displays on the design space where you can add the elds and controls you want.

Add a Branch Using the Add Branch Window  
You can create complex branches that re when dierent events occur or when multiple elds are changed. Creating
branches using the Add Branch window is similar to creating script or workspace rules and many of the procedures you
use are identical, including those to select triggers and conditions.

This section provides an overview of creating a branch using the Add Branch window. For information about script
rules, see Script Rules. For detailed procedures to create workspace rules, see Add a Workspace Rule.

1. From your open script, select the page you want to add the branch to on the page selector.
2. Do one of the following:

◦ Click the Page tab and then click Add Branch.

◦ Right-click the page you want to add a branch to on the page selector.
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3. Select whether you want to branch to a new page or a page you have already placed on the script. The Add
Branch window opens.
Three buons display on the top of the Add Branch window—Triggers, Conditions, and Go to Page. You
construct the branch by clicking each buon and specifying the triggers that determine when the branch
should be checked, what conditions must be met for the branch to take agents to a new page, and the page the
branch will take agents to.

4. Select one or more triggers that will cause the branch to re. Specifying branch triggers is identical to specifying
triggers for script and workspace rules and the triggers that are available for branches are the same as those
available for script rules. As with script rules, there are four triggers that are unique to scripts beyond those also
available as workow triggers.

◦ Page Loaded—Select this item to trigger the branch immediately after the page the branch is on is
opened.

◦ A Buon is Clicked—Select this item to trigger the branch when Next on the navigation panel is clicked
to proceed to the next page.

◦ The Exit Script Event Fires—Select this item to trigger the branch when Exit on the navigation panel
is clicked to exit the page. The Exit buon displays on the script page only if there is a branch or
subsequent page allowing sta members to navigate to another page. For this reason, exit script events
usually occur before the script has reached the nal page.

◦ The Finish Script Event Fires—Select this item to trigger the branch when Finish on the navigation
panel is clicked to leave the script. Finish displays only if there is no branch or subsequent page to
navigate to from the script page. For this reason, nish script events usually occur after the script has
reached the nal page for the branch. For descriptions of the other triggers and how to add them to your
branch, see Workspace Rule Triggers.

When multiple triggers are specied, the branch conditions will be checked if any of the actions for the trigger
occur. For example, the branch could be triggered when the value in a eld on the script is changed or when a
buon on the script is clicked.

5. Click Conditions to add conditions that must be met to trigger the branch. The conditions available for script
branches are identical to those available for workspace and script rules. See Workspace Rule Conditions.

6. Click Go to Page to select the page you want the script to display immediately after the branch is triggered and
all conditions are met.
This step is not necessary if you chose to create a branch to a new page in step 3 since the branch will be
automatically congured to go to the new page. However, you can select a dierent target page if you want.

a. Select the appropriate option to dene where the branch should go when the branch conditions you
specify are met. You can select Go to Beginning of Script (the rst page of the script), Go to Next Page,
Go to Previous Page, or Go to a Certain Page.

b. If you select Go to a Certain Page, this option is added to the branch description. Click the underlined
text in the branch description to open a window where you can select the page you want.

c. Select the page you want to branch to.
d. Click OK.

7. Click Finish.
8. Repeat these steps to add other branches from the page.

Tip:  Branches are red in the order in which they are listed. This can impact how the branches aect
the script.
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Modify Branches  
This section describes how to edit, delete, and reorder script rules using the tools available on the Page tab.

After you add branches, you can easily edit, reorder, and delete them from the Page tab. It is important to update
existing branches when you make changes to your script to ensure the branches work as you expect. For example, when
you add a new branch to a page, you need to make sure that other branches on the page do not have similar conditions.
If they do, you can edit or delete the other branches, or reorder the branches so the branch you want to trigger will be
checked rst.

1. From your open script, select the page the branch is on from the page selector and click the Page tab.
The branches list, located on the Branching group, displays all the branches created on the page.

2. In the branches list, select the branch you want to modify.
3. To edit the branch, click Edit Branch.

The Edit Branch window opens. See How Branches Work in Scripts.
4. To change the order of the branch, click the up or down arrow to move the branch where you want it.

Note:  Just like script and workspace rules, branches are red in the sequence in which they are listed.
This can impact how the branches on a page aect the script.

5. To delete the branch, click Delete Branch.

Script Rules  
You can create script rules to trigger actions on script pages when the conditions you specify are met. For example, you
can create a rule that automatically sets the value of a eld on a script page when a buon on the page is clicked or the
page is opened.

Note:  Whereas workspace rules apply to the entire workspace, script rules impact only the script pages the
rules are created on.

After you create script rules, they can be modied if you need to change their triggers, conditions, or actions. You can
also reorder the rules on your page to ensure they re in the order you want. If you no longer need a rule, you can also
quickly delete it. See Modify Script Rules.

Generally, script rules impact only the items on the script page you add the rules to. However, using named events, you
can use script rules in conjunction with workspace rules to trigger an action on a workspace when conditions on the
script are met. For example, a workspace rule that sets the incident workspace Status eld to Solved can be triggered
when a sta member clicks a buon on a script page. See How Events are Used in Workspace and Script Rules.

Related Topics
• Workspace and Script Fields

• Workspace and Script Controls

• Field and Control Properties

• Overview of the Dynamic Agent Desktop
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Create a Script Rule  
You create script rules from the Add Rule window, which is opened from the Rules tab on the script editor. You specify
the triggers, conditions, actions, and properties just as you would when creating a workspace rule. However, there are a
few triggers and actions that are unique to script rules.

This section provides an overview of the process to create a script rule and describes the triggers and actions that are
unique to scripts. For detailed procedures to create script and workspace rules, see Add a Workspace Rule.

Note:  Creating script rules is similar to creating script branches, though branches take agents to script pages
whereas rules trigger actions you specify in the rule.

1. From your open script, select the page you want to place the rule on from the page selector.
2. Click the Rules tab and click Add Rule.

The Add Rule window opens. Five buons display along the top of the window—Triggers, Conditions, Then
Actions, Else Actions, and Properties. You construct the rule by clicking each buon and adding dierent items
to the rule description.

3. Select one or more triggers that will cause the rule to re. There are four triggers that are unique to scripts
beyond those available as workspace rule triggers.

◦ Page Loaded—Select this item to trigger the rule immediately after the page the rule is on is opened.

◦ A Buon is Clicked—Select this item to trigger the rule when Next on the navigation panel is clicked to
proceed to the next page.

◦ The Exit Script Event Fires—Select this item to trigger the rule when Exit on the navigation panel is
clicked to exit the page. Exit displays on the script page only if there is a branch or subsequent page
allowing sta members to navigate to another page. For this reason, exit script events usually occur
before the script has reached the nal page for the branch.

◦ The Finish Script Event Fires—Select this item to trigger the rule when the Finish buon on the
navigation panel is clicked to leave the script. Finish displays only if there is no branch or subsequent
page to navigate to from the script page. For this reason, nish script events usually occur after the script
has reached the nal page for the branch.

For descriptions of the other triggers and how to add them to your rule, see Workspace Rule Triggers.
4. Click Conditions to add conditions that must be met for the rule to re and perform the actions you specify.

The conditions available for script rules are identical to those available for workspace rules. See Workspace Rule
Conditions.

5. Click Then Actions to dene the actions that should occur immediately after the triggering event if the
conditions are met.
There are two actions that are unique to script rules:

◦ Fire Exit Script Event—Select this action to re a subsequent rule that uses the Exit Script Fires condition.
Using this option, you can add your own Exit buon to a script page to trigger the same rule red by Exit
on the navigation panel control.

◦ Fire Finish Script Event—Select this action to re a subsequent rule that uses the Finish Script Fires
condition. Using this option, you can add your own Finish buon to a script page to trigger the same rule
red by Finish on the navigation panel control. See How Events are Used in Workspace and Script Rules.
For descriptions of the other rule actions and how to add them to your rule, see Workspace Rule Actions.

6. Click Else Actions to dene the actions that should occur if the conditions are not met.
The Fire Exit Script Event and Fire Finish Script Event actions described in step 5 are also available to use as Else
actions in script rules. See Workspace Rule Actions.

7. Click Properties and enter the name of the rule in the Rule Name eld.
8. Enter any notes you want to add to the rule in the Notes eld.
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9. To deactivate the rule, clear the Active check box.
10. Click Finish.

Related Topics
• Workspace and Script Fields

• Workspace and Script Controls

• Field and Control Properties

• Add a Workspace Rule

Modify Script Rules  
After you add script rules, you can easily edit them, reorder them, or delete them when they are no longer needed. This
section describes how to edit, delete, and reorder script rules using the tools available on the Rules tab.

Rules are red in the sequence in which they are listed. Adjusting them can impact how other rules aect the script. For
example, if multiple rules set dierent values for the same eld, the eld will be set to the value assigned by the last rule
in the sequence.

1. From your open script, select the page the rule is on from the page selector and click the Rules tab. The rule list
displays all rules created on the page.

a. To view only rules that are triggered by or that impact a specic item on the page, such as a eld or
control, select the item, click Filter List on the Rules tab, and select Rules Triggered by Selected Object
or Rules that Reference Selected Object.
The rule list updates to display only rules that are related to the selected item.

2. In the rule list, select the rule you want to modify.
3. To edit the rule, click Edit Rule.

The Edit Rule window opens. See Script Rules.
4. To change the order of the rule, click the up or down arrow to move the rule where you want it.

Note:  Deleting a rule is permanent and cannot be undone. To ensure that a rule is not needed before
deleting it, you can disable it instead. To disable a rule, edit the rule, click Properties on the Edit Rule
window, clear the Active check box, and click Finish to save the change.

5. To delete the rule, click Delete Rule.

How Events are Used in Workspace and Script Rules  
Events are dened by adding event re actions. This topic describes how to use events in workspace and script rules
using the various event types.

Script rules, workspace rules, and workow connectors can be triggered by actions taken by sta members, such as
changing a eld value or saving a record. However, they can also be triggered by other rules using rule-dened events.
Events are dened by adding event re actions, which vary by event type.

• Named Event—Named events are dened by adding the Fire a Named Event action to a script rule or
workspace rule and specifying a name for the event.

• Exit Script Event—Exit script events are dened by adding the Fire Exit Script Event action to a script rule. (Exit
script events are also red automatically when a sta member clicks Exit in a script.)

• Finish Script Event—Finish script events are dened by adding the Fire Finish Script Event action to a script
rule. (Finish script events are also red automatically when a sta member clicks Finish in a script.)
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Note:  Although exit script events and nish script events perform similar roles, they are intended to serve
slightly dierent purposes. Exit script events usually occur before the script has reached a nal page for the
branch, while nish script events usually occur after the script has reached a nal page. In this way, you can
distinguish between an early exit from the script and a case where the script was followed to completion.

After an event is dened as a rule action, the event can be used to trigger other rules. Any workspace rule or script rule
congured for the workspace that uses the event as a trigger is run immediately after the event is red—conditions are
evaluated and, if they are matched, the rule actions are run. Events can also be used to trigger any workow connector
that is connecting from the workspace.

Exit and nish script events can be red only in script rules. However, named events can be red in either script or
workspace rules. Therefore, while you can use a named event, exit script event, or nish script event to trigger a
workspace rule from a script rule, only a named event can be used to trigger a script rule directly from a workspace rule.
(A workspace rule could take other non-event actions that result in a script rule being red indirectly.)

Fire a Named Event in a Rule  
Whether you are ring a named event in a script rule or a workspace rule, the process for using it is the same.

The following procedure explains how to re a named event in a rule.
1. From your open script, create a new rule and specify the triggers and conditions that should run the rule. See

Add a Workspace Rule.
2. Click the Then Actions tab and click Add next to the Fire a Named Event action.
3. Click the underlined named event text in the Rule Description area.
4. Enter a name for the named event that will re when the rule runs.

Tip:  The name you specify has no restrictions on the characters you can use and is not case sensitive.
However, we suggest entering a simple name since you will need to enter it again when adding the
event as a rule trigger.

5. Click OK.
6. Click Finish.

Trigger a Rule When a Named Event is Fired  
The following procedure explains how to use an event as a trigger for another rule. The process for using an exit script
event or nish script event is similar.

1. From your open script, create the rule that you want the named event to trigger and specify conditions and
actions for the rule. See Add a Workspace Rule.

2. Click Add next to A Named Event Fires.
3. Click the underlined named event text in the Rule Description area to open a window where you can enter the

name of the named event that you want to trigger the rule.
4. Click OK.
5. Specify any remaining triggers, conditions, and actions you want to use in the rule. See Script Rules.
6. Click Finish.

Preview a Script  
When you are editing a script, it can be helpful to see what it will look like when sta members use a workspace that
includes the script. The preview feature lets you see the script as it will appear on a workspace, so you can modify it if
necessary.
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When previewing a script, you can navigate between pages using the navigation buons and branches you create to
verify they function as expected.

Note:  When you preview a script, it will display as it would to any sta member who has the same set of
prole permissions you have. To view the script as it will appear to a specic sta member with dierent
permissions, you must log in using a sta account with the same prole as the sta member.

1. From your open script, click the Home tab.
2. To view the script as it will appear to sta members when creating new records using a workspace with this

script, click Preview and select New Record.
A preview of the new record opens.

3. To view the script as it will appear when editing an existing record on a workspace, click Preview and select
Opening a Record.

a. Enter the record ID number.
b. Click OK. A preview of the record opens with the script elds populated with values from the record you

specied.
4. Click X on the window or press Esc.

Export a Script  
This topic describes how to export a script as an XML le.

Scripts can be exported as XML les and stored on your workstation or network and then imported to other interfaces.
This is helpful if you have a script on one interface and want to quickly create a duplicate or similar script on a dierent
interface. The exported script XML le includes all of the script elements, including elds, controls, branches, rules, and
the script layout.

1. From the Scripts explorer, right-click the script you want to export and select Open.
The script opens.

2. Click File and select Export Script.
The Save As window opens.

3. Select the directory where you want to save the script denition le and enter the le name.
4. Click Save.

Note:  When a script is exported to a script denition le, the le includes a hash value that is used
when the le is imported to determine if the le has been modied externally. If the le has been
modied, it will not be available for importing, and an error message will notify you that the le is
invalid.

Import a Script  
This topic describes how to import a script using the script import wizard.

An imported script becomes its own unique copy and can be modied without impacting the original. When you are
ready to import the script, the script import wizard guides you through the import process.

1. From the Scripts explorer, click New.
The New Script window opens.

2. Click Import Script from an Exported Script File to open the Import Script wizard.
3. Click Next.
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The next window asks you for the name of the script denition le you want to import.
4. Do one of the following :

◦ Enter the full path of the script denition le.

◦ Click Browse to nd the script denition le on your workstation and click Open.

5. Click Next to select the script type.
6. Click the Map To Type drop-down menu and select a record type to map the workspace to. By default, the

imported script is mapped to the same script type as the original script.

Note:  If items from the script you are importing are not used in the script type you are converting
it to, the next window lists these items and informs you that they will be replaced by spacers, eld
placeholders, or removed from the imported script. Since most database elds and script controls are
not shared by script types, the majority of elds and controls will generally not be included in the new
script when you convert the type. However, this option is helpful if you want to import the general
layout from a script with a dierent type.

7. Click Next.
8. Click Finish.

The script designer opens with the imported script.
9. Edit the script to remove or replace elds that are not available and then save the script. See Edit a Script.

When you save a script, reports that are used in the script report controls are checked to ensure they exist on the site.
If a report does not exist, a message is placed in the control stating the report is no longer available. You can save a
script that has invalid reports, but you will need to select new reports for the controls before they can be used in the
workspace.

Workspace and Script Elements  

Overview of Workspace and Script Elements  
To provide you with a consistent, intuitive design environment, Oracle Service Cloud workspace and agent script editors
share a common set of design elements for constructing agent desktops for your sta members.

In many instances, the design space, elds, controls, and rules available for creating workspaces function the same
when creating scripts. First, you add elds and controls to the design space, and then adjust the properties of each
item so that it displays and behaves as desired. You can also customize the buons that appear on the ribbon and the
Quick Access toolbar for workspaces and for scripts that are used in workows. Because the design tools are similar
for workspaces and scripts, the experience you gain in creating workspaces can help you beer understand and create
scripts, and vice versa.

Tip:  To understand how workspaces and scripts can best be implemented in your agent desktop, you should
also become familiar with other desktop components such as guides and workows. For a summary of agent
desktop features, see Overview of the Dynamic Agent Desktop.
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Design Space Layout Options  
The design space is the working area where you arrange elds and controls as you want them to appear on your
workspace or script.

On most new workspace layouts, the design space contains a summary panel and a tab set control, while script layouts
feature a content area with header and footer sections. Each of these design areas contains a table, hidden by default,
that forms an underlying grid for aligning elds and controls.

Initially, these tables contain a single row and column, and the rst item added to them lls the height and width of a
single cell. As you add other elements, additional rows and columns are automatically added with new cells holding
each added eld and control. Moving or removing an item from a cell will cause the other cells to adjust automatically to
ll the space left by the removed item.

Tip:  Although there is no limit to the number of rows and columns allowed, you should avoid using large
numbers of them so that the layout is easier to use. Also, when adding items to a workspace, try to keep elds
and controls roughly the same height on the same row, since the height of the row is determined by the tallest
element. For example, a date eld is generally displayed with only one line of information, whereas a notes
eld with a text box is taller.

When adding and arranging items on the design space, it can be helpful to show the table outlines to help you identify
the layout structure.

Related Topics
• Display or Hide Design Space Table Outlines

• Change the Number of Table Rows and Columns Used by a Field or Control

Display or Hide Design Space Table Outlines  
Use this procedure to display or the hide design space table outlines on your workspace or script.

1. From an open workspace or script, click the Home tab.
2. Click Show Outline to display the outline.
3. Click Show Outline again to hide the outline.

When Show Outline is highlighted, the table outline is displayed.

Change the Number of Table Rows and Columns Used by a Field or Control  
You can change the display of information when you increase or decrease table rows and columns used by a eld or
control.

In some cases you may want a eld or control to span more than one table cell. For example, if you add an incident
subject line to a workspace with three columns in the table, the subject line will be only one column wide, too narrow
to display much information. By spanning the eld over multiple columns, you can expand the eld to display the full
content of the subject line. You can also span an item over multiple rows if you want it to expand vertically.

Note:  In order to span an item over multiple columns or rows, there must be empty table cells adjacent to the
cell containing the item you are expanding.

1. From an open workspace or script, click the eld or control that you want to edit on the design space.
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2. Click the Design tab.
3. Click Table Cell.

The number of rows and columns the selected table cell occupies is shown when selecting row and column
span options.

4. To span the eld or control over an additional table row, click Increase Row Span.
5. To span the eld or control over one less table row, click Decrease Row Span.
6. To span the eld or control over an additional table column, click Increase Column Span.
7. To span the eld or control over one less table column, click Decrease Column Span.
8. Click Save on the Quick Access toolbar.

Workspace and Script Fields  
A eld holds a piece of information that is stored in the knowledge base. For example, a contact record includes elds
for name, email, address, and phone number.

To add a eld to a workspace or script, just drag it from the ribbon and place it on the design space. You can also
promote sta eciency by dening a shortcut key in the eld label that can be used to focus the eld.

For information about a eld on the ribbon, you can hover over it for a description. Fields are listed in alphabetical order.
Dierent icons are displayed next to each eld showing the eld type, which impacts how the eld will be shown. In
addition, required, linkable, and customer-entered elds have unique properties when using them on workspaces and
scripts.

Tip:  Information about each eld can also be found in the Data Dictionary. You can access the data dictionary
by clicking  Conguration > Database > Data Dictionary .

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Workspace

• Edit a Script

Workspace and Script Field Types  
The elds you can add to your workspace or script are shown on the Insert Field tab, and are associated with icons to
indicate the type of input they accept. For example, elds that accept phone numbers are displayed with a phone icon.

You can hover over a eld icon to see a description of the eld and the eld name as it appears on the API, regardless of
any changes that might have been made to the message base label.

Icon Field Type

Field with drop-down menu options
 

Field with search capability
 

SmartSense meter for rating emotional context of messages
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Icon Field Type

Field with calendar for selecting date and time
 

Text box eld
 

Integer eld
 

SLA selection eld
 

Address eld
 

Email address eld
 

Phone number eld
 

Currency eld
 

Quote document selection eld
 

Contact lists eld
 

Required Fields for Workspace Types  
Each workspace and script type has certain required elds when working on records.

Oracle Service Cloud requires that certain elds always be populated when using workspaces or scripts to update
certain record types. For instance, all incidents must have a contact, so the contact eld is always required when it is
added to incident workspaces and scripts. Likewise, opportunities must always have a contact or organization, so you
must add a contact eld or an organization eld, if not both, to all opportunity workspaces and scripts.

In some cases, elds are required only if a record is associated with another record. For example, when using a contact
workspace, if a contact is associated with an organization, the Organization Name eld is required. If the contact is not
associated with an organization, the eld is not required.

You can save a workspace or script that does not include elds required for its type, but you must include them if the
workspace or script will be used to create new records. When you place one of these required elds, you cannot edit the
Required property since these elds are always required.

Tip:  Labels for required elds appear in red text with an asterisk. Fields that are not always required can be
set to required by changing their Required properties or by using workspace rules. Most elds are required
by default when placed on a script page, with the exception of chat scripts. However, in many cases, you can
change the Required property to be not required after you place it on the script.  See How You Set Hidden,
Required, and Read-Only Properties and Workspace Rules.

This table lists elds that are always required when added to each type of workspace. Fields required for each script type
are the same as those required for the corresponding workspace type.
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Workspace Type Required Fields

Answer and Answer Multi Edit
 

Display Position, Language, Status, and Summary
 

Asset and Asset Multi Edit
 

Name, Product, and Date Purchased
 

Contact and Contact Multi Edit
 

Disabled Flag and State
 

Incident and Incident Multi Edit
 

Contact, Interface, State, and Status
 

Opportunity and Opportunity Multi Edit
 

Interface, Manager Commit, Rep Commit, and
 
Status
 

Organization and Organization Multi Edit
 

Organization Name and State
 

Quote
 

Name, Forecast, and % Discount
 

Quote Product
 

Discount and Quantity
 

Task
 

Name and Status
 

Task Multi Edit
 

Status
 

Workspace and Script Custom Fields  
The availability and behavior of custom elds in the knowledge base is aected by the following visibility seings.

• Admin Display—When selected, the custom eld is available in the list of elds that can be added to the design
space.

• Admin Edit—When selected, the custom eld will be set to Read Only by default when it is added to the design
space. After the custom eld has been added to the design space, this seing has no eect.

• Chat Display—When this option and the Admin Display check box are both selected, the custom eld is
available in the list of elds that can be added to chat workspaces.

• Required on Accessibility Interface—When selected, the custom eld will be set to Required by default when
it is added to the design space. After the custom eld has been added to the design space, this seing has no
eect.

Note:  If an additional instance of a eld is placed on the design space, it will automatically be set to the same
Required seing as the rst instance. It is not possible to set the same eld to both required and non-required
in the same workspace.

When a workspace or script is used by sta members, all behavior related to visibility, read-only, and required aributes
is determined by the properties dened for each eld. See How You Set Hidden, Required, and Read-Only Properties.
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Related Topics
• Custom Field Visibility Seings

Customer-Entered Fields  
The following elds can be added to the Account Seings page on the customer portal so customers can personalize
their knowledge base search results. These elds have a default read-only property when added to a workspace or
script, and are not available on contact multi-edit workspaces.

• Lines Per Page—The number of items to list per page when the customer is searching on the Answers page.

• Search Text—The default search text to use for searching on the Answers page.

• Search Type—The default search method.

Linkable Field Types  
When you add the following elds to a workspace or script, sta members can click the action link associated with the
eld to access special functionality.

• Email eld—This eld includes a click-to-email link that opens the sta member’s email client with a blank
message to the selected address. This behavior can be disabled by selecting the Disable Email Icon option on
the Design tab.

• URL eld—A custom text eld set to URL usage includes a link to open a URL in a web browser.

How Fields Are Added to Workspaces and Scripts  
The design space is structured by a table, even if you have not enabled the display of its rows and columns by clicking
the Show Outline buon.

How the table changes when you add elds to a workspace or script depends on several factors: where you add them,
whether other elds already exist in the column or row, and whether the column or row contains controls. You can add
elds above or below another eld or control, or you can add them to the right or left. For example, the following image
shows how the Assigned eld is selected and placed in a new row below Reference # and Contact ID on the workspace.
When you select the eld and hover over the workspace, a horizontal indicator shows where the eld will be placed.

These examples have the table outline displayed for clarity. To display the outline for a workspace or script, click Show
Outline on the Home tab.

Simply click to add the eld in that position.
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To add a eld to the right or left of another eld or control, click the eld on the ribbon and hover over either side of a
eld on the design space. When the vertical indicator appears, click to add the eld to the table.

This action adds the eld to a new column in the table.

As columns are added, the original columns are evenly redistributed to make room. For example, when you add a eld
to the right side of a two-column table, the original columns narrow to span the left two-thirds of the workspace and the
new column lls the remaining third.
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When a table contains open cells, as it does in the previous image, you can drag a eld directly into one of the cells.
When the eld is positioned over a cell, the cell will become highlighted to show you where the eld will be placed. Like
the indicators, this highlight appears whether or not you click Show Outline.

Tip:  You can also add a column or row to the table by right-clicking any empty cell and selecting Add Column
or Add Row.

Add a Field to a Workspace or Script  
The following procedure describes how to add a eld to a workspace or script.

1. From an open workspace or script, click the Insert Field tab.
2. Click Object Type Selector.

Note:  The elds available depend on the type of workspace or script you are adding them to. See
Standard Workspaces or Script Types. Custom elds can be added to the design space only if their
Admin Edit visibility seing is selected. See Overview of Custom Fields.

3. Click the type of eld you want to add to the workspace.
The ribbon is updated to display the elds for the record type you select.

4. To view elds that do not t on the ribbon, click the up and down arrows on the scroll bar on the right of the
ribbon.

5. To view all the elds available for the workspace type you are editing, click Expand Fields below the scroll bar.
6. Click the eld you want to add.
7. To add the eld to an open cell in the design space table, hover over the cell and then click when it becomes

highlighted.
8. To insert the eld between elds or controls already added to the design space, hover the mouse between the

elds or controls and then click when the line indicator appears.
9. To set a shortcut key for the eld, click Text on the Design tab, enter a label for the eld, and enter an

ampersand (&) in front of the character you want to be the shortcut key. For example, to allow sta members to
move the focus to a eld with the label “Details” by pressing Alt+T, enter De&tails.

Tip:  You can also click the label on the design space to edit the label value without clicking Text.

10. To edit other eld properties, see Edit a Field or Control.
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Move a Field on the Design Space  
You can easily rearrange the elds on the design space by moving them from one location to another.

1. From the open workspace or script, click the eld you want to move, keeping the left mouse buon depressed.
2. Drag the eld to its new location on the design space.
3. Release the mouse buon to position the eld in the new location.

Remove a Field from the Design Space  
You can also quickly remove any elds that you no longer need.

Just as rows and columns can be added to a table when you add elds to the design space, the table rows and columns
will be deleted when you move or delete the only remaining eld in the row or column.

1. From the open workspace or script, do one of the following:

◦ Right-click the eld and select Delete. The Delete Conrmation window opens.

◦ Select the eld, click the Design tab, and then click Delete.

CAUTION:  The Delete Conrmation window displays a warning if the eld you are deleting is used in
a rule. If the rule checks or changes the value of the eld you want to remove, the window will display
a warning, but the rule will remain active after the eld is removed. However, if the rule aects the
required, visibility, or read-only properties of the eld you want to remove, you will receive a warning
and the rule will be disabled after the eld is removed. See Overview of Workspace Rules.

2. Click Yes to conrm the deletion.

Workspace and Script Controls  
In addition to elds, you can enhance your workspace or script by adding controls.

Controls are used to place features, such as buons, text labels, reports, tables, and tab sets, onto the design space.
Depending on the control, you can modify its properties to change its appearance or add functionality. For example,
you can add the Title Bar control to a design space and then edit the title text, font, size, and color. Most controls can be
added to every type of workspace and script as many times as you want.

Controls are added to workspaces from the workspace designer Insert Control tab. If your site is congured to use
custom add-in components, they will also be displayed on this tab. (Your prole determines the custom add-ins you
can access.) Custom add-ins can be added, moved, and deleted from workspaces in the same way as you would add,
move, and deleted controls and relationship items. For information about custom add-ins, contact your Oracle account
manager.

While some controls are used to increase general usefulness, others are required to edit certain information. For
example, you have the option to add a workspace title with the Title Bar control, but you can use a workspace without a
title bar just as easily. Alternately, it is necessary to add the Rich Text Incident Thread relationship item to a workspace to
let sta members view or add incident threads. See Relationship Items.
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Tip:  You can easily identify a control that has been placed on a workspace by double-clicking the control. The
control name will appear in the drop-down menu on the Selected Object buon group on the Design tab.

Control Description

Answer Display
 

Displays an answer on a workspace or script. To select the answer you want, click Answer ID on the
Design tab and enter the answer ID number.
 

Browser
 

Adds a browser window to a workspace or script. Click URL on the Design tab to enter a URL for the
browser. You can also set a URL for the browser from a workspace rule or script rule. See Workspace
and Script Browser Controls.
 

Buon
 

Inserts a buon control on a workspace or script. Workspace rules and script rules can be created
to trigger an action when the buon is clicked. For example, you can create a buon that displays
a hidden eld when sta members click the buon. See Workspace and Script Buon and Image
Controls.
 

Hyperlink
 

Places a hyperlink on the workspace or script. Click URL on the Design tab to enter a URL for the link.
 

Image
 

Adds an image to your workspace or script to display a logo, a diagram, or other type of image.
Properties for this control let you choose the image you want and specify how the image should be
displayed. You can create workspace rules and script rules that trigger actions when images are clicked.
See Workspace and Script Buon and Image Controls.
 

List Box
 

Adds a list containing entries you specify that can be selected by the agent. You can create workspace
rules and script rules that are triggered when one or more list items are selected. See Workspace and
Script List Box, Menu, Option, and Text Box Controls.
 

Menu
 

Adds a drop-down menu containing entries you specify that can be selected by the agent. You can
create workspace rules and script rules that are triggered when a menu item is selected. See Workspace
and Script List Box, Menu, Option, and Text Box Controls.
 

Navigation Panel
 

Adds a script navigation panel that allows agents to access the beginning page, previous page, next
page, or exit the script. Selection can be presented as buons or links. By default, this control appears
in buon style in the script footer. You can create workspace rules and script rules that are triggered
when Exit is clicked. See Workspace Rule Triggers.
 
This control is available to scripts only.
 

Oracle Business Intelligence Report
 

Inserts a read-only Oracle Business Intelligence Report. The report path you enter must match the path
used in OBIEE (Oracle Business Intelligence Enterprise Edition).
 

Panel
 

Groups elds and controls and provides the ability to scroll within subsections of a workspace or script.
You can nest a panel within a table and then add multiple elds to the panel. A scroll bar lets sta
members view all elds on the panel. See Workspace Panel Controls.
 

Policy Automation
 

The Policy Automation control can be added to workspaces when Oracle Policy Automation is enabled
on your site, providing access to policy administration tools for determining eligibility and tracking
compliance for programs and services. For information about Oracle Policy Automation, see Oracle
Applications Integrations with Oracle Service Cloud.
 
To enable Oracle Policy Automation with Oracle Service Cloud, contact your Oracle account manager.
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Control Description

 

Progress Label
 

Adds a simple progress indicator that displays the current page number and total number of pages in
the script. By default, this control appears in the script header.
 
This control is available to scripts only.
 

Radio Buons
 

Adds options (radio buons) to a workspace or script. You can create workspace rules and script rules
that are triggered when an option is selected. See Workspace and Script List Box, Menu, Option, and
Text Box Controls.
 

Report
 

Places a report container on a workspace or script. Click the Report property and select the report you
want to display on the workspace. See Default Reports Used on Standard Workspaces.
 

Script
 

Adds agent scripts to a workspace. When you add this control, the Select a Script window opens
where you can select the script you want to add. You can also select a dierent script by selecting the
script control and clicking the Script buon on the Design tab. See Add a Script Control to the Design
Space.
 
This control is available to workspaces only.
 

Spacer
 

Adds white space, lls gaps within a workspace or script, or holds a place for a eld you want to insert
later. When added to the design space, spacers have a light gray background to let you know where
they are. However, when the workspace or script is viewed by an agent, the spacers are not visible
because they are the same color as the background. You can move or delete a spacer just as you can
move and delete other elds and controls.
 

Survey by Proxy
 

Adds a survey to a workspace or script that can be lled out by an agent on behalf of a customer. When
this control is added, you choose the survey you want by clicking Survey on Design tab. If you select
a survey that allows anonymous responses, you can select the Anonymous check box on the Design
tab to permit survey responses to be entered when a valid contact is not associated with the record
being viewed. The Survey by Proxy control is available when creating incident, opportunity, and contact
workspaces and scripts. See Overview of Surveys.
 
This control is available only when Oracle RightNow Feedback Cloud Service is enabled. Polling surveys
are not supported by this control.
 

Tab Set
 

Adds a tab set to a workspace or script. Tabs can be added and renamed as desired, and multiple tab
sets can be placed or nested on the design space. See Add Tabs to the Design Space.
 

Table
 

Adds a table to a workspace or script. Tables form a grid for aligning other elds and controls. They can
also be nested in other tables. See Add a Table to the Design Space.
 

Text
 

Adds a text block to a workspace or script. Using the buons in the Label group on the Design tab,
 you can dene the background color, text alignment, and content. You can also enter text, including
variables, that will display when agents use the workspace. See Add Text with the Text Control.
 
A text control default background color and font match the workspace it is used on.
 

Text Box
 

Adds a text box to a workspace or script. You can create workspace rules that are triggered when
agents enter specic text in the text box. See Workspace and Script List Box, Menu, Option, and Text
Box Controls.
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Control Description

Title Bar
 

Adds a text block to be used for headers or sections within tables. Using the buons in the Label
group on the Design tab, you can dene the background color, text alignment, and content. By default,
 the Title Bar control uses a heading style font and a dierent background color than the rest of the
workspace.
 

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Workspace

• Edit a Script

Relationship Items  
This topic describes workspace relationship items.

Oracle Service Cloud features a set of relationship items that provide functionality unique to certain workspaces.
Relationship items are special controls, such as incident threads and audit logs, that are used when working with records
and related objects. Many relationship items display a list of related objects and include basic functions for adding,
editing, copying, and deleting related records, as well as removing record relationships.

Relationship items dier from the standard controls mainly in the types of workspaces they can be used on and the
number of times they can be added to a workspace. While controls can be added numerous times on most types of
workspaces, relationship items are specic to the type of workspace and can be added to a workspace only once.

In the standard workspaces, most relationship items appear on tabs, but you can place them anywhere on the
workspace. The items you can add when you create a workspace depend on the type of workspace you create.

Tip:  You can easily identify a relationship item that has been placed on a workspace by double-clicking the
item. The name will appear in the drop-down menu on the Selected Object buon group on the Design tab.

Relationship Item Description

Answer Type Container
 

Displays the answer type options, tabs, and toolbars for adding and editing the question and answer,
 and a tab to preview the question and answer. This relationship item is available when creating answer
workspaces.
 

Assets
 

Provides the ability to add, edit, print, copy, delete, and email assets, as well as remove their association
with the primary record. The column headings for the list of assets include the name, serial number,
description, product, date purchased, date installed, date retired, status, and action options. The Assets
relationship item is available on contact and organization workspaces.
 

Audit Log
 

Describes the actions that have been taken on the record, including when an action was taken, who
performed it, what the action was, and any additional description of the action. This relationship item is
available on the following types of workspaces.
 

• Answer

• Asset

• Contact
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• Custom Object

• Incident

• Opportunity

• Organization

• Quote

• Task

In answer workspaces, the audit log shows all actions taken on both the answer and its siblings.
 

Chat Control
 

Contains the area for composing a response to the customer and includes the buons for adding
SmartAssistant answers, searching the knowledge base, and inserting standard text. This relationship
item is available on chat workspaces.
 

Chat Transcript Control
 

Contains all chat correspondence between the customer and agent, including a time stamp for each
instance of sending text. This relationship item is available on chat workspaces.
 

Cobrowse
 

The cobrowse relationship item can be added to incident and chat workspaces when cobrowsing is
enabled on your site. When using a workspace with this relationship item, agents can invite customers
to a desktop-sharing session. See Chat for Agents, Supervisors, and Customers.
 

Collaboration
 

The Collaboration relationship item can be added to incident workspaces when Service Collaboration
is enabled on your site. You can select the default page view for the control from the drop-down menu
under Options in the workspace editor. When using a workspace with this relationship item, agents can
collaborate with other agents to resolve customer questions. See Service Collaboration.
 

Contacts
 

Provides the ability to add, edit, print, copy, delete, and email contacts, as well as remove their
association with the primary record. The column headings for the list of contacts include the name,
 email address, organization name, oce phone, title, and action options. The Contacts relationship
item is available on incident, opportunity, and organization workspaces.
 

[Custom Object] View
 

Provides the ability to add, edit, copy, print, and delete custom object records, as well as remove their
association with the primary record for the workspace. The column headings for the list of records
include the object ID, labels, and action options. This relationship item is named for the custom object
and is available when creating workspaces for standard objects that have been related to the custom
object. See Overview of Custom Objects.
 

File Aachments
 

Provides the ability to aach, open, download, and delete les from records as well as view le
properties. The relationship item displays a list of le aachments, including name, size, date
created and updated, and a description. This relationship item is available on the following types of
workspaces.
 

• Answer

• Contact

• Custom Object

• Incident

• Opportunity

• Organization

• Task

In answer workspaces, les can be aached to the answer as well as all sibling answers.
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Relationship Item Description

 

Guided Assistance
 

Provides the ability to search for and open guided assistance guides to help agents quickly nd
answers or text explanations when working with customers. You can select properties for this
relationship item to show buons on the relationship item that agents can use to search for and select
applicable guides. You can also use workspace rules to automatically open a guide on workspaces
that include this relationship item, or trigger a workspace rule when a guide has been completed. See
Guided Assistance Relationship Item.
 
This relationship item can be added only to incident and chat workspaces. However, you can add the
answers.guided assistance eld to answer workspaces to associate a guide with an open answer.
 

Incident View
 

Provides the ability to view and work with incidents associated with a contact or organization. Toolbar
buons allow adding, editing, copying, deleting, forwarding, and proposing incidents and lling the
inbox. The column headings for the list of incidents include the status, response time, resolution time,
 source, reference number, and subject as well as action options. The Incident View relationship item is
available when creating chat, interaction, contact, organization, and asset workspaces.
 

Label
 

Allows placement of a label on the chat workspace.
 

Learned Links
 

Lists all answers linked to the currently open answer by visitors to your site as they browsed your
knowledge base. These links are “learned” by the system as your visitors move from answer to answer.
Toolbar buons allow the ability to edit, print, preview, promote, and block and unblock links. This
relationship item is available when creating answer workspaces.
 

Manually Related Answers
 

Lists all answers that have been manually linked by sta to the currently open answer. Toolbar buons
allow the ability to add, edit, copy, print, and delete answers, as well as remove their association with
the primary record. This relationship item is available when creating answer workspaces.
 

Model Question
 

Provides the ability to associate an answer with a question template in Oracle RightNow Virtual
Assistant Cloud Service. This relationship item is available when creating answer workspaces. See
Overview of Answers.
 

Notes
 

Notes relationship items can be specic to individual workspaces.
 
Answer Notes—Allows sta members to add notes, select the note channel, and sort notes by date on
answer workspaces.
 
Contact Notes—Allows sta members to add notes, select the note channel, switch the view between
contact and organization notes, and sort notes by date on contact workspaces.
 
Custom Object Notes—Allows sta members to add notes, select the note channel, and sort notes by
date on custom object workspaces.
 
Meta Answer Notes—Allows sta members to add notes that pertain to the sibling answers.
 
Opportunity Notes—Allows sta members to add notes, select the note channel, switch the views
between opportunity, contact, and organization notes, and sort notes by date on opportunity
workspaces.
 
Organization Notes—Allows sta members to add notes, select the channel, and sort notes by date on
organization workspaces.
 
Task Notes—Allows sta members to add notes, select the note channel, and sort notes by date on
task workspaces.
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Note:  If you want sta members to be able to edit or delete existing notes when copying
records, you will need to assign Edit/Delete Notes permissions in their prole for the
appropriate record types. See Overview of Sta Management.

Outreach Activity View
 

Displays a report of outreach activity associated with the contact, such as mailings that were viewed
or tracked links that were clicked. If the report is populated (that is, if the contact has had outreach
activity), the column headings include when the activity occurred, what the activity was, a description,
 the name of the mailing or tracked link, and any documents for each listed activity. The Outreach
Activity View relationship item is available when creating contact workspaces.
 

Opportunities View
 

Provides the ability to view and work with opportunities associated with a contact or organization.
Toolbar buons allow adding, editing, copying, printing, deleting, rejecting, and forwarding
opportunities. The column headings for the list of opportunities include the name, assigned sta
member, status, stage, the sales representative’s value, the manager’s value, and the date updated,
 as well as action options. The Opportunities View relationship item is available when creating chat,
 contact, and organization workspaces.
 

Organization Hierarchy
 

Provides the ability to work with organizations to create a hierarchy in an organization workspace.
Toolbar buons allow adding, editing, printing, and deleting organizations, as well as removing their
association with the primary record.
 

Page Peek
 

Displays a snapshot of the web page customers were viewing when they initiated the chat. This
relationship item can be added to chat and interaction workspaces.
 

Products and Categories
 

Displays product and category trees in order to view and dene the links between products and
categories for answers. The Products and Categories relationship item is available when creating
answer and multi-edit answer workspaces.
 

Quote Products
 

Displays the list of products associated with a selected price schedule for a quote and provides the
ability to edit products for a quote. The Quote Products relationship item is available when creating
quote workspaces.
 

Quotes
 

Provides the ability to view and work with quotes associated with an opportunity. Toolbar buons allow
adding, editing, printing, copying, deleting, and sending quotes. The column headings for a list of
quotes include the name and status, whether it was sent, the forecast, and action options. The Quotes
relationship item is available when creating opportunity workspaces.
 

Rich Text Incident Thread
 

Provides the ability to add responses, customer entries, and private notes to incidents with a variety
of HTML formaing aributes, such as font, style, color, alignment, bullets, images, links, and
indentation. This relationship item also includes buons for accessing SmartAssistant, searching
answers, inserting standard text, zooming in and out on thread contents, and undocking the
relationship item. (The Messages tab of the standard incident workspace contains the Rich Text
Incident Thread relationship item.) This relationship item is available when creating incident and
incident multi-edit workspaces.
 

Sibling Relationships
 

Lists all answers that share the same product or category as the currently open answer and can
also contain the same le aachments. Toolbar buons allow adding, editing, printing, deleting,
 and previewing sibling answers, as well as removing their association with the primary record. This
relationship item is available when creating answer workspaces.
 

SLA Instance View
 

Allows sta members to view a report of SLAs that have been associated with a contact or organization
and provides the ability to add, open or disable an instance. The column headings include the SLA
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instance name, active date, expire date, self-service, total incidents, and action options. The SLA
Instance View relationship item is available when creating contact and organization workspaces.
 

SLA Container
 

Provides the ability to select SLAs for contacts and organizations by displaying the SLA selection eld,
which opens the SLA Viewer for adding SLA instances. The SLA Container relationship item is available
when creating contact and organization workspaces.
 

Survey History View
 

Allows sta members to view a report of surveys that have been sent to contacts. If the report is
populated (that is, if the contact has received surveys), the column headings include when the survey
was completed, the score, the type of survey, its name, and action options. The Survey History View
relationship item is available when creating contact workspaces.
 

Tasks
 

Provides the ability to view and work with tasks associated with a record. Toolbar buons allow
adding, editing, printing, copying, deleting, completing, and forwarding tasks, as well as removing
their association with the record. The column headings for a list of tasks include the name, due date,
 completed date, assigned sta member, and priority, as well as action options. The Tasks relationship
item is available when creating the following kinds of workspaces.
 

• Answer

• Contact

• Incident

• Mobile Contact

• Mobile Incident

• Opportunity

• Organization

Time Billed
 

Provides the ability to view and enter the amount of time billed for an incident. Toolbar buons allow
adding, editing, and deleting a time billed entry. The column headings for a list of time billed entries
include the starting date and time, the amount of time spent, the sta member who entered the time
billed, and the task, as well as action options. The Time Billed relationship item is available when
creating incident workspaces.
 

Visitor Browser History
 

Allows sta members to view a list of URLs a contact visited before starting a chat. The Visitor Browser
History relationship item is available when creating chat and interaction workspaces.
 

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Workspace

Question Controls  
Oracle Service Cloud provides a set of question controls that are used to congure branching in scripts.

Questions are available as buons, options, lists, text elds, menus, and yes/no buons. Most of these question types
are similar to standard controls—for example, you add items to a menu question in the same way you add items to a
menu control. However, questions dier from other controls in a few key ways.

• Questions include labels while other controls do not. The label can be used to present the text of the question
being asked.
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• Questions are required by default but can be set to non-required by using the Required property on the Design
tab. This diers from other controls, which are never required.

• A question added to one script page can be used in the rules and branches created on other pages in the script.
Conversely, a control can be used only in the rules and branches on the script page the control is added to.

• Some question types have dierent properties than their corresponding standard controls. For example, the
image property cannot be dened for buon questions as it can for buon controls.

For information about using question controls in script branching, see How Branches Work in Scripts.

Note:  The values that agents enter in questions and their corresponding standard controls are available for
use with the script rules and branches. However, they are not saved in the database.

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Script

Add a Control to the Design Space  
Placing controls on a workspace or script is similar to adding elds. Like elds, controls occupy cells on the underlying
table for the design space.

After you add a control, you can reposition it to display anywhere on the design space. Controls can be added to tables,
panels, and tab set controls, and you can place them above, below, or next to elds and other controls.

Note:  When you add a control to a table that already contain elds or other items, the size of the table rows
and columns is adjusted to accommodate the new object.

1. From an open workspace or script, click the Insert Control tab on the designer ribbon.
2. Click the control you want to add.
3. Drag the control to the design space and hover over the location where you want to place the control.

A vertical or horizontal line indicates where the control will be placed on the design space.
4. Release the mouse buon.
5. To edit the properties of the added control, see Edit a Field or Control.

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Workspace

• Edit a Script

Move a Control on the Design Space  
You can easily move controls to other locations on your design space. As with elds, moving controls can cause the
removal of a row or column from the design space table if the control was the only remaining item in the row or column.

1. From the open workspace or script, click the control you want to move, keeping the left mouse buon
depressed.

2. Drag the control to its new location on the design space.
3. Release the mouse buon to position the control in its new location.
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Delete a Control from the Design Space  
You can easily delete controls if they are no longer needed. As with elds, deleting controls can cause the removal of a
row or column from the design space table if the control was the only remaining item in the row or column.

1. From the open workspace or script, right-click the control and select Delete. The Delete Conrmation window
opens.

CAUTION:  If the control you are deleting is referenced in a workspace rule, the Delete Conrmation
window will display a warning including the name of the rule. If you click Yes to delete the control, the
reference will be removed and the rule will be disabled. See Workspace Rules.

2. Click Yes to conrm the deletion.

Workspace and Script Buon and Image Controls  
You can add buons to workspaces and scripts that you can use with rules to trigger actions when clicked. For example,
you could add a buon to a workspace to display an additional tab set when a sta member clicks it.

Image controls are used to display a logo, diagram, or any other graphic. Images can also be used to trigger rules when
clicked, but their more common purpose is to visually enhance the design.

Tip:  Because the agent desktop uses image rendering components of Internet Explorer installed on your
workstation, we recommend that your browser be congured to check for newer versions of stored pages
every time web pages are visited. In this way, any image updates you perform as you design your workspace
will be displayed promptly without requiring you to log out and back in to Oracle Service Cloud.

When you add a buon or image to a workspace or script, it will have no eect on your rules until you congure the
rules to use it. For information about using buons and images in workspace rules, see Workspace Rule Triggers.

Add Content to Buon Controls  
You can modify buon controls added to the design space to customize the appearance on a workspace or script.

When you add a buon to the design space, the buon contains default text. You can easily change the text and add an
image to the buon by selecting it on the design space and changing the buon properties from the Design tab. You
can also size the buon and specify where it should be positioned.

1. From the open workspace or script, click the buon control you added to the design space.
2. Click the Design tab.
3. To change the default text on the buon, click Text.

a. Enter the text you want on the buon.
b. Press Enter to save the text.

Tip:  You can change the font aributes of text on a buon by clicking the buon and choosing from
the Label group options on the Design tab.

4. To add an image to the buon, click Image. The Select Image window opens, showing the images you have
added using the Client Workow Images explorer.

a. Select the image you want to add to the buon.
b. To add a new image to the list, click Add New Image.
c. To remove an image that was previously added to the buon, select the No Value check box.
d. Click OK to add the image to the buon.
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e. To position the image on the buon in relation to text on the buon, click Image Align and select where
you want the image in relation to the text. The available options are Left, Right, Top, Boom, and Center.

Note:  For information about adding images for use with workspaces and scripts, see Add an Image
Control to a Workspace or Script.

5. To manually dene the width of the buon margins, click Margin. The available options are None, Narrow,
Medium, Wide, and Custom.

a. To set custom margin widths, select Custom and enter the number of pixels you want for the buon
margins in the Top, Boom, Left, and Right elds.

6. To manually dene the buon size, click Size on the Design tab and select Enable Auto Sizing to disable it.
a. Click Size again and enter the number of pixels you want for the buon size in the Width and Height

elds.
b. To re-enable auto sizing, click Size and select Enable Auto Sizing.

7. To position the buon on the table cell that contains it, click Position on the Design tab to view available
options.

a. Select where you want the buon placed on the table cell from the Position options.
b. To stretch the buon on the table cell, select how you want the buon displayed from the Stretch options.

8. Click Save.

Add an Image Control to a Workspace or Script  
When you add an image to a workspace or script, you can specify options such as the size, position, and layout of the
image.

1. Drag the control to the design space. See Add a Control to the Design Space.
The Select Image window opens showing the images you have added using the Client Workow Images
explorer.

2. To add a new image to the list, click Add New Image.
3. Select the image you want to add and click OK. The image is added to the design space.

To select a dierent image, select the image you want to replace, click the Image buon, and choose the new
image from the Select Image window.

4. To manually dene the image size, click Size on the Design tab and select Enable Auto Sizing to disable it.
a. Click Size again and enter the number of pixels you want for the image size in the Width and Height

elds.
b. To re-enable auto sizing, click Size and select Enable Auto Sizing.

5. To specify a layout for the image on the table cell, click Image Layout and select from None, Tile, Center,
Stretch, and Zoom.
The Image Layout buon is inactive when auto sizing is enabled.

6. To position the image on the table cell that contains it, click Position.
a. Select where you want the image placed on the table cell from the Position options.
b. To stretch the image on the table cell, select how you want the buon displayed from the Stretch options.

Tip:  Stretch options from the Position buon work best when a layout option is selected from the
Image Layout buon on the Design tab.

7. Click Save.

Client Workow Images Explorer  
Using the Client Workow Images explorer, you can add images to use in workspaces and scripts.
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After you have opened the explorer, you can add and manage images the same way you do in the Images explorer. See
Images Explorer.

Click Conguration on the navigation pane, expand Application Appearance, and then double-click Client Workow
Images.

Note:  You can add the Client Workow Images explorer to navigation lists in the same way you can add other
explorers. See Overview of Navigation Sets.

Add Text with the Text Control  
You can use text controls to add text that will display to your agents. You can also include variables to display values
from the database. For example, you could add text, including the customer’s name, that new agents can read when
speaking with a customer who calls regarding an incident.

1. Click the Insert Control tab and add a text control to the design space.
2. Click the text control on the design space and enter the text you want.
3. To change the font aributes for the text you entered, select the text you want to change and select options

from the font aributes on the Label group on the Design tab. See Label Properties for descriptions of these
options.

4. To add a variable to the text, click the text control where you want to add the variable.
5. Do one of the following:

◦ Click Insert Merge Field on the Design tab.

◦ Right-click the control and select Insert Merge Field.

6. Do one of the following:

◦ Select the name of the database table with the eld you want in the Table Name eld.

◦ Select Current User to add a variable for the display information (such as the rst name) of the sta
member who is using the workspace or script.

Note:  Custom object workspaces and scripts can also use custom object elds as merge elds.
However, workspaces and scripts for parent standard objects, such as contacts or incidents, cannot
access these elds.

7. Select the eld you want to include on the text control on the Field Name eld.
The variable you dene is displayed in the Preview eld.

8. Click OK to add the variable to the text control.

Workspace and Script List Box, Menu, Option, and Text Box
Controls  
List box, menu, option, and text box controls give you the ability to trigger workspace rules, script rules, script branches,
or workows from agent selections or text entries.

List box, menu, option, and text box controls dier only in the type of input they accept from your agents and are added
to workspaces in the same way you add any other control. However, with the exception of the text box control, you need
to add entries to these controls that agents can select before the controls are useful.
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Note:  The values entered in these controls are not saved in the record being edited. These controls are
intended for use only with workspace rules, script rules, script branches, and workows.

After you add menu and list entries or options to the controls, you can create rules that are triggered when agents select
the entries or buons, or when they enter certain text in a text box. You can also add rule conditions based on the value
of these controls. See Workspace Rules.

You can specify options on the Design tab for the list box, option, and text box controls to change their behavior or
appearance. For denitions of the options for these and other controls, see Workspace and Script Controls.

Add and Edit Items for List Box, Menu, and Option Controls  
The following procedure explains how to add and edit items for list box, menu, and option controls.

1. From an open workspace or script, click the Insert Control tab and add a list box, menu, or radio buon control
to the design space.

2. Click the control on the design space and click the Design tab.
Three default items are added to the control when you add it to the design space.

3. To change the text of an item in the control, select the item you want to edit on the items list and click Edit
Item. The Edit Item window opens.

a. Enter the text you want the item to display.
b. Click OK.

Note:  For option controls, you can also edit the text of an item by simply clicking the item on the
design space.

4. To add an item to the control, click Add Item on the Design tab to open the New Item window.
a. Enter the text of the item you want to add to the control.
b. Click OK to add the new item to the control.

5. To change the order of an item on a control, select the item you want to move on the items list and click Move
Up or Move Down to order the item as you want it.

6. To remove an item from the list, select the item you want to remove on the items list and click Delete Item.
7. To change the layout of an option control, select the control on the design space, click Layout on the Design

tab, and select Horizontal or Vertical.
8. To allow sta members to make multiple selections from a list box, click the list box control on the design space,

click the Design tab, and select the Allow Multiple Selections check box.

Edit Items from the Edit Items Window  
If you want to add or edit several items on list, menu, or option controls, it can be faster to do so from the Edit Items
window than from the Design tab. You can reorder items from the window as well as add and edit items on the control.

1. From an open workspace or script, right-click the control on the design space and select Edit List Items, Edit
Items, or Edit Radio Buons, depending on the type of control you select.
The Edit Items window opens. The window lists all the menu items, list items, or radio buons on the control.

2. To add another item to the control, click Add Item and enter the item text.
3. To edit item text, select the item in the list and click Edit Item.
4. To remove an item from the list, select the item you want to remove and click Delete Item.
5. To reorder items in the list, select the item you want to reorder and click the up or down arrow to move the item

where you want it.
6. Click OK.
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Default Reports Used on Standard Workspaces  
This topic describes the default reports used on standard workspaces.

Workspaces and scripts can include reports to let sta members view or access information related to the record they
are editing. For example, the standard incidents workspace contains a tasks report to display the tasks associated with
the incident. Most of the standard workspaces contain reports, and you can congure custom workspaces and scripts to
show the reports you want to see.

Note:  Record command options are not applied when viewing reports in workspaces.

Many standard workspaces contain reports, most of which have row limits of 100 rows. If you want to use a standard
workspace but with a dierent report than the default one, you can copy the workspace and edit the copy to replace the
default report with the report you want.

Standard Workspace/Tab or Control Default Report

Answer

Tasks
 

Tasks by Answer
 

Details
 

Answer Subscribers
 

Analytics
 

Answer Overview
 

Chat Sessions

Incidents
 

Incidents by Contact
 

Contact

Opportunities
 

Opportunities by Contact
 

Tasks
 

Tasks by Contact
 

Incidents
 

Incidents by Contact
 

Surveys
 

Survey History
 

Marketing Activity
 

Marketing Activity
 

Incident

Contacts/Contacts
 

Incident Contacts
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Standard Workspace/Tab or Control Default Report

Contacts/Incident History
 

Incidents by Contact
 

Tasks
 

Tasks by Incident
 

Organization/Incident History
 

Incidents by Organization
 

Organization/Contacts for Org
 

Organization Contacts
 

Web Visit
 

Incidents Web Visit Tab
 

Opportunity

Contacts
 

Opportunity Contacts
 

Tasks
 

Tasks by Opportunity
 

Quotes
 

Quotes
 

Organization

Contacts
 

Organization Contacts
 

Opportunities
 

Opportunities by Organization
 

Tasks
 

Tasks by Organization
 

Incidents
 

Incidents by Organization
 

Quote

Quote Products
 

Quote Product List
 

Note:  Some standard workspaces also dene default search reports for certain elements. For example, the
Search Knowledge Base buon on the Messages tab of the Incident workspace uses the Search Knowledge
Base report. See How You Select Search Reports.

How You Add Reports and Relationship Items to Custom
Workspaces and Scripts  
When you add the report control to the design space, you need to select the report you want it to display.
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Reports used on workspaces and scripts may include runtime selectable lters and variables. However, with the
exception of the reports used for search reports, these will not be available when the reports are viewed on workspaces
or scripts.

By default, reports you add to workspaces do not run when you open the workspaces to create new records, since the
records do not yet include data that can be ltered on. However, you can force reports to run for new records from the
Report Behavior buon on the Design tab.

You can also select reports for relationship items to show information related to the record you are viewing. For
example, the Contacts relationship item shows information about the contact related to an incident you are viewing.
These relationship items are congured to use certain reports by default, but you can select dierent reports to use on
your workspace if you want.

Note:  If the same object is added as a child in multiple relationships to the same parent (for example, if
the contacts object is specied as the child of the incidents object in two relationships), the workspace
designer ribbon will still contain only one view item for the object. However, because new view reports are
automatically created for each child relationship you dene, when you add the view item to a workspace, you
will be prompted to select which report to use. See Overview of Custom Objects.

Reports used on report controls or relationship items automatically aempt to lter on the record being edited to
display information related to the record. Therefore, these reports should contain at least one lter for the primary
identication types for the kind of workspace or script you are using. For example, reports used in incident workspaces
should lter on incident (i_id), contact (c_id), or organization (org_id).

Add a Report to a Report Control or Change a Report on a Relationship Item  
You can add a report to a report control on a workspace. You can also change a report on a relationship item.

1. From an open workspace or script, click the Insert Control tab.
2. Click the report control or the relationship item containing a report and drag it to the design space where you

want it.
3. Click the control or relationship item on the workspace and click the Design tab. Conguration options for the

report control are displayed on the Options buon group.

Tip:  You can also double-click an object on the design space to select the Design tab and access
properties related to the object.

4. Click Report to open the Select Report window.
5. Select the report you want to add to the workspace and click OK.
6. Click Save.

Note:  If you add a report control to a workspace without selecting a report for the control, you will not
be able to save the workspace.

How You Select Search Reports  
Some database elds and relationship items include search functionality that agents can use to nd and associate
records with the records being edited.

When using a workspace or script, agents can access the search function by clicking Search located next to the eld or
on the relationship item. For example, the buon to open the Contact Search window from an incident workspace is
located to the right of the contact eld.
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When you open a search window, the window displays a report and the docked lters that are used to search for
records. Some search windows also include secondary reports that are not searchable, but which can be used to display
information below the primary search report. For example, a secondary search report can be used to display all contacts
associated with an organization when you are searching for a contact in the primary search report.

Drill-down levels and report links can be used in search reports for database elds but are disabled on the search report
relationship items.

Legend for image: 1. Search Report with docked lters 2. Secondary Search Report

The standard reports that are used by default with this functionality are designed to allow sta members to quickly
locate the records they want. However, if the default reports do not meet your needs, you can specify the standard or
custom reports you want to use for the primary and secondary search reports.

Note:  Searches are performed from workspace search reports using docked lters. For this reason, the search
reports you specify must include docked lters in order to search for records. See Overview of Custom Reports.

Select Primary and Secondary Search Reports for the Contacts Search Window  
You can add primary and secondary search reports to a eld or a relationship item. The following procedure explains
how to add search reports to the Contacts Search window.

1. From an open workspace or script, do one of the following:

◦ Click the Contact eld on the design space.

◦ Click the Contact relationship item on the design space.

2. Click the Design tab.
3. To change the primary search report, do one of the following:
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Note:  To clear a secondary report from the Contact Search window, select the No Value check box
on the lower left of the Select Report window. This check box displays only when selecting secondary
search reports.

◦ Click Search Report. The Select Report window opens.

◦ To add a secondary search report, click Secondary Search Report.

4. Select the report you want to use.
5. Click OK.
6. Click Save.

Report Properties  
In addition to selecting the report you want to appear on a workspace or script, you can modify the report properties to
enable certain behaviors and functions. The following report functions are available on the Design tab.

• Time Limit—Species the maximum amount of time a report can take to generate on the workspace. See Set a
Time Limit for a Report Control.

• Hide Report Commands—Hides and disables the report commands (for example, New, Open, Copy, Delete,
Print, Forward, Assign, and Propose) on the workspace.

• Show Row Count—Displays the number of records in a report next to the tab title.

The properties described here can also be accessed by clicking Report Behavior on the Design tab.

Property Description

Delay Report Execution Select this option if you want the report to run only when the tab the report is shown on is selected.
If this option is not selected, the report runs when the workspace opens. This option is enabled by
default.
If the report is visible when the workspace is opened (for example, it appears on the top tab), it will
always run immediately even if the property is enabled.
 

Filter on Primary Key Only Select this option if you want the report to lter only on the primary key. If this option is not selected,
 the report will also lter on any related objects. For example, when this option is enabled, an incidents
report will use only the incident ID lter to lter the results. When the option is disabled, the report will
also lter the report on any of the workspace elds selected on the Report Filter Mapping Wizard. See
Filter Workspace Fields on a Workspace Report.

Open Existing Records in Separate
Workgroup

Select this option if you want records opened from this report to be displayed in a new workgroup
tab. This allows the opened record to be saved independently from the record the control is on. If this
option is not selected, records will be opened on a sub-tab and edits are saved when any record in the
sub-tab workgroup is saved.

Delete Records Immediately Select this option to delete records in the report when a sta member clicks Delete and conrms the
deletion request. If this option is not selected, records will be queued for deletion and not actually
deleted until the record being edited is saved.

Create New Records in Separate
Workgroup

Select this option if you want new records created from a parent record to open in a new workgroup
tab. This allows the new record to be saved without saving the parent record. If this option is not
selected, new records will open on a sub-tab and edits are saved when any record in the sub-tab
workgroup is saved.
This property is available for the Incident View, Opportunity View, Task View, and Custom Object View
relationship items.
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Property Description

Refresh Report When Data Changes Select this option if you want the report to be run again when related data is changed. (For example, if
a sta member is using a workspace that contains the Incidents by Organization or Contact report and
changes the contact, the report refreshes to update with new information.)
This property is not available for the Manually Related Answers, Learned Link, Incident View, and
Custom Object View relationship items.
 

Execute for New Records Select this option if you want the report to run when you open the workspace to create a new record.
This option is disabled by default to prevent reports that rely on data in the record from aempting to
run when a new record is being created.
This property is not available for the Manually Related Answers, Learned Link, Incident View, and
Custom Object View relationship items.
 

Filter Workspace Fields on a Workspace Report  
With workspace lter mapping, you can leverage data on a workspace with internal and external object tables.

Use the Report Filter Mapping Wizard to select any eld on a workspace to lter on the report and set its runtime value
as the lter value.

1. Select the report on the Design tab of the workspace.
2. Click Report Behavior and clear the Filter On Primary Key Only option.
3. Click Filter Mappings.

The Report Filter Mapping Wizard opens.
4. Click the Use drop-down menu and select Parent.

A list of all available elds for the workspace display in the Value drop-down menu.
5. Select the eld you want the report to lter at runtime.
6. Click Finish.

Set a Time Limit for a Report Control  
You can specify the maximum amount of time a report can take to generate on a workspace using the Time Limit
option.

Specifying a time limit can improve workspace performance since workspaces are unavailable until reports on the
workspace generate. If a report takes longer to generate than the time limit you specify, a warning message will display
and the workspace will load without the report.

1. From the open workspace or script, click the report control you want to modify.
2. Click the Design tab and click Time Limit.
3. Select the Limit Report Execution check box and then enter the maximum number of seconds you want to

permit for a report to generate. You can select a value up to 240 seconds.
4. Click OK.

Note:  Reports placed on a workspace should be congured to return data that is related only to
the record that is open. For example, a report on a Contact tab should return information about the
contact rather than all contacts in the database. Reports that consistently time out in a workspace and
cannot be further restricted should be removed from the workspace and run separately.
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Workspace Panel Controls  
A panel is a special workspace control that provides grouping for elds and controls and lets you create scrolling
subsections of the workspace.

When you add more elds than the panel control can accommodate, a scroll bar appears automatically. This lets you
add multiple elds to a panel even though the panel size is controlled.

You can customize each panel on your workspace to use dierent background colors, font colors, padding, and margins.
This is helpful if you want to create distinct groupings of data on your workspace.

This image shows a panel control on the right. The panel has been dened to span three rows. The single panel
contains the Assigned, Product, Category, Disposition, and Queue elds.

The next image shows what happens to the panel control when more elds are added to the workspace, creating
additional rows. Note that the panel still spans only three rows and now displays a scroll bar.

And this last image shows how the panel is displayed to sta members using the workspace. They can scroll down on
the panel to complete all elds.

Add a Script Control to the Design Space  
You can add scripts to workspaces to provide a sequence of steps and form elements for your agents to follow when
working on records.

Script controls can include the same elds and controls available for workspaces, and you can use the same script on as
many workspaces as you want. If you want to place a set of elds and controls on several workspaces, you can add them
to a script and then simply place the script on the workspaces.
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Script controls are available only when scripting is enabled. For information about enabling scripts, contact your Oracle
account manager.
Scripts can also include pages and branching, so you can easily create a script to lead your agents through a procedure.
For example, you could place a script control on an incident workspace to guide new agents through entering
information for the record when a customer phones with a new incident. See Script Designer.

As with workspaces, scripts are interface specic. In addition, the scripts that you can place on a workspace must be of
the same type as the workspace. For example, you can place a control for an incident script on an incident workspace
and you can place a control for a contact script on a contact workspace. For this reason, when you place a script control
on a workspace, you can select only scripts that are of the same type as the workspace, and that were created on the
same interface.

Note:  You can place multiple script controls on the same workspace.

1. From an open workspace, click the Insert Control tab and click Script.
2. Click the location on the design space where you want the script.

The Select a Script window opens.
3. Select the script you want to use and then click OK.
4. To change the script used on the script control, click the script control and click Script on the Design tab to

open the Select a Script window.
5. To change the size of the script control, click the control on the workspace, click the Design tab, select the Set

Fixed Height check box, and click Size to enter a size for the control. See Design Property Descriptions.

Add a Table to the Design Space  
You can add table controls to the design space to organize and align elds and controls within a set of content cells.

By default, a newly placed table control features two rows and two columns containing spacers. You can adjust the
number of rows and columns by editing the table properties or by inserting elds or controls around or between other
elds and controls in the table. You can also enhance the appearance of a table by adjusting colors, borders, scroll bars,
and size.

Tables can be nested within the cells of other tables. However, for optimal workspace performance, we recommend
limiting the number of nested tables as these can increase workspace processing time.

1. From the open workspace or script, click the Insert Control tab and click Table.
2. Click the location on the design space where you want the table. The table contains two rows and columns by

default.
3. To add columns or rows to the table, click the table on the design space, click the Design tab, and click Add

Column or Add Row. The table updates to show the new columns and rows.

Tip:  If you nd it dicult to select the table by clicking on its outer border, it may be easier to select it
using the Current Selection drop-down menu. See Access Design Space Items Using the Ribbon.

4. To edit table properties, such as borders and background color, see Layout Properties.
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Add Tabs to the Design Space  
You can add individual tabs and tab sets, or groups of tabs.

1. From the open workspace or script, click the Insert Control tab on the ribbon, click Tab Set, and click the
location on the design space where you want the tab set.

Tip:  You can nest tab sets within other tab sets.

2. To add tabs, do one of the following:
◦ Right-click next to an existing tab and select Add Tab.

◦ Right-click an existing tab and select Add Tab Before or Add Tab After.

3. Rename the tab.
a. Click the new tab.
b. Click the Design tab.
c. Click Text on the Label group and enter the name you want for the tab.

How You Move a Tab  
You can move individual tabs and tab sets, or groups of tabs. Tabs are moved with the same methods used to move
elds and controls on the upper section of the workspace.

Sta members have the option of dragging the tabs to rearrange them on the workspace. If they do this, the tabs
positions are stored in their local seings. Your changes to the tab positions will not aect sta members who have
customized their tab positions on the workspace. For an overview of account seings that can be customized by sta
members, see Download the Oracle Service Cloud Client and Log In.

Right-click the tab and select Move Left or Move Right.

Or

Click the action arrow on the tab and select Move Left or Move Right. See How You Access Design Properties from the
Actions List for a description of action arrows.

Delete a Tab or Tab Set  
You can delete individual tabs and tab sets, or groups of tabs. Tabs are deleted with the same methods used to move
elds and controls on the upper section of the workspace.

1. Right-click the tab or tab set and select Delete.
2. Click Yes on the Delete Conrmation message.

Workspace and Script Browser Controls  
By adding a browser control to a workspace or script, you can display a web browser inline with your records.
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You can specify the URL you want, and you can include variables in the URL to link Oracle Service Cloud data—such as
record IDs, custom eld values, or custom object eld values—with the web page you open or through Oracle RightNow
Connect APIs. See  Answer ID 2429  on our customer support site.

Also, the page loaded in the browser can contain RightNow Connect JavaScript code to view and edit information about
the record being edited. See the Connect Desktop Integration (Javascript API) documentation.

Add a Browser to a Workspace or Script  
Use this procedure to add a browser to a workspace or script.

1. Click the Insert Control tab and click Browser.
2. Click the location on the design space where you want the browser.

The browser is added to the workspace.
3. Click the browser control and click the Design tab.
4. Click URL and enter the URL you want the browser control to open when the workspace is opened.

You can also set the URL of a browser control using a workspace rule. See Workspace Rule Actions.
5. To delay the loading of the browser in a tab until the tab is active, select the Delay Page Load check box. The

Delay Page Load check box is selected by default.

Note:  If you place a browser control on a tab that is not the active (or top) tab when the workspace
opens, we recommend that you keep the control Delay Page Load property set to its default enabled
state. If this property is not enabled, the browser control will be activated when the workspace is
opened, which may prevent other controls on the workspace from functioning as expected.

6. To change the size of the browser control, click the Design tab and select the Set Fixed Height check box.
a. Click Size to enter a size for the control.

7. To open windows from the browser content in child browser controls, select the Open Pop-ups in New
Browser Control check box.
If this check box is not selected, windows will open in a full Internet Explorer browser, which can cause session
variables to be lost. To ensure session variables are maintained, select the check box.

8. To send the URL as POST data so that it is sent securely, select the Send URL as Post Data check box. If you do
not select this check box, the URL is sent as GET data. If you select this check box, you must enter a URL that
starts with hps in the URL eld.

9. To suppress any warning prompts (such as script errors and authentication requests) that may occur in the
browser control when a URL is loaded, select the Suppress Errors and Authentication Dialogs check box.

Field and Control Properties  
Fields and controls (including relationship items and script questions) have aributes you can congure using the
options on the Design tab of the designer ribbon. Many of these aributes are shared by numerous items such as size,
label position, and read-only aributes.

Note:  When you change the properties of a eld or control, the design space is updated to reect your
changes.

The properties you can edit depend on the eld or control you are editing. Click any of the following links to learn more
about the associated property.

• Considerations for Using the Default Value Property
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• Custom Field Properties

• How You Set Hidden, Required, and Read-Only Properties

• Considerations for Seing Hidden and Read-Only Properties for Required Fields

For a full list of all properties and their descriptions, see Design Property Descriptions.

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Workspace

• Edit a Script

View Item Properties  
You can quickly view all the properties for a eld or control from the Design and Rules tabs. This helps you see what
properties are already applied to an item before you edit the item.

1. From an open workspace or script, click an item on the design space.
2. Click Show Details on the Design tab.

The Selected Object Details window opens. The information that displays depends on the item you select and
the properties that are applied to it. Any property applied to the item will be shown on the window, including
the item positioning on the workspace and any visibility, hidden, or read-only aributes. See Field and Control
Properties for descriptions of the properties that can be applied to items on workspaces.

3. Click Close.

Edit a Field or Control  
You can edit a eld or a control on the design space of a workspace or script.

When you select a eld or control on the design space, the Design and Rules tabs are displayed on the ribbon with
buons appropriate for the selected item. To select an item, you can click it on the design space or you can select it from
the Current Selection drop-down menu on the Design tab.

1. From an open workspace or script, click a eld or control on the design space and click the Design tab. The
options displayed on the tab vary depending on the item you select.

Tip:  You can also double-click an object on the design space to select the Design tab and access
properties related to the object.

2. Click a buon on the Design tab to adjust the property you want to change. See Design Property Descriptions.
The object is updated on the design space to reect the change.

3. Click Save.

Related Topics
• Access Design Space Items Using the Ribbon

How You Select Multiple Fields and Controls  
If you want to edit properties shared by a number of elds and controls, you can select them and then edit them
simultaneously.

You can select multiple elds and controls on the design space to edit properties they share or remove them from your
design space. When you select multiple elds and controls, Delete on the Design tab will be available on the ribbon,
along with buons to edit common aributes of the selected elds and controls. For example, if you select two elds
and a title bar, you will be able to click Read Only on the Design tab, since both elds and controls have this aribute.

658



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

Press Ctrl while selecting the elds and controls on the design space that you want to edit or delete.

Access Design Space Items Using the Ribbon  
You can select elds and controls using the ribbon to access design space items.

The Current Selection drop-down menu displays a tree structure showing all the elds and controls on the design space.
You can use this menu to select items on the design space to view or edit.

When you navigate the tree structure and click a eld or control, it is highlighted on the design space and the options on
the Design tab are updated to reect the actions you can take on the item. This lets you quickly nd and select a specic
eld or control on the design space and access its properties without having to locate it on the design space.

1. From an open workspace or script, click an item on the design space to activate the Design and Rules tabs on
the ribbon.

2. Click the Design or Rules tab.
3. From the Selected Object group on the ribbon, click the Current Selection drop-down menu.

The tree opens listing the elds and controls on the design space. The item you selected in step 1 is
automatically selected in the tree.

4. Expand or collapse the tree to navigate to the eld or control you want to view.
5. Click the item in the tree to select it on the design space.

How You Access Design Properties from the Actions List  
In addition to using the buons on the Design tab to edit elds and controls on the design space, you can open an
actions list that is unique for each item. The actions list contains some of the same options accessed from the Design
tab.

Using the actions list can be helpful when the designer ribbon is collapsed. You can access the actions list either by
right-clicking an item on the design space or by selecting the item and clicking the action arrow. The action arrow
appears on the upper right side of each selected item on the design space. The list of action options display. To select
an action, click it in the list.

Custom Field Properties  
You can add custom elds to workspaces and scripts just like a standard database eld.

Since you can modify certain properties of custom elds when you create them on the Custom Fields editor, there are
some considerations to be aware of when editing custom elds you add to a workspace.

• If a default value was dened for the custom eld when it was created, that default value will appear when you
place the eld onto the design space. To override the original default eld value and set a dierent default
value from the design space, you must enable the Default Value, From Workspace, or From Script property. See
Considerations for Using the Default Value Property.

• If a mask was specied for the custom eld when it was created, you can view the mask by clicking RNT Mask
on the Design tab on the ribbon. You cannot specify masks for custom elds when you place them on the
design space. See Overview of Custom Fields.

• If you add a custom eld that was congured to be required when it was created, the required property for the
eld will be enabled on the design space by default. However, you can disable the required property if you do
not want to require the eld. See How You Set Hidden, Required, and Read-Only Properties.

Note:  Custom eld properties dened on the editor aect eld behavior only on the workspace or script
you are editing. Properties aecting the behavior of custom elds on the customer portal are dened on the
Custom Fields editor and are not aected by eld properties set in a workspace or script.
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Considerations for Using the Default Value Property  
When you edit a workspace or script, you can set a default value for some elds on the workspace.

When a sta member creates a new record using the workspace or script, the eld is automatically populated with the
default value that you select.
The default value is applied only to new records created in the workspace or script. Records created from other
channels, such as the Ask a Question page, are not impacted.

In addition to the Default Value property, there are a few other methods by which values can be set. When conguring
your business processes in Oracle Service Cloud, carefully consider the following order in which these defaults are
applied.

1. Values dened by Oracle Service Cloud itself, as described by the Data Dictionary.
2. Values applied by the workspace Default Value property.
3. Values applied when creating a record for a contact selected in a report.
4. Values applied from entering information in a search lter, such as when searching for a contact that is not

found, then creating a new contact.
5. Values applied by rules triggered when the editor loads.

Sta members with appropriate permission can change the default value of a eld. For example, if you have a
group of agents that generally handles incidents for a certain product, you can create an incident workspace
that has a default product specied for the Product eld. As a result, all incidents that the group creates will
initially be set to the default product. However, if they need to associate a dierent product (and they have
appropriate permissions), they can change the eld to a dierent value.

Enable the Default Value Property and Set a Default Value for a Field  
When you add a eld to the design space that can have a default value, the Default Value From Workspace property for
the eld is initially disabled and must be enabled before you can dene a default value.

1. From the open workspace or script, click a eld on the design space.
2. Click the Design tab and click Default Value.

Note:  Default Value displays only if the selected eld accepts default values from the workspace.

3. Select From Workspace or From Script to enable the Default Value property.
A check displays next to the property that you have enabled.

4. Click the eld you want to add the default value to. Editing options are displayed according to the eld type. For
example, you can enter text directly into a text eld on the design space or select from a drop-down menu on a
menu eld.

5. Click Save.

How You Set Hidden, Required, and Read-Only Properties  
You can apply Read–Only, Required, and Hidden properties to many of the items you add to a workspace or script.

• Read–Only—Read–Only items are displayed to agents, but agents cannot change the values in the elds or
controls. This property is not available for multi-edit workspaces.

• Required—Required items are displayed to agents. When agents use the workspace or script to edit a record,
they are required to enter a value for the eld in order to save the record.

• Hidden—Hidden items are not displayed to agents.

When you set any of these properties, you can choose when the property should be applied to the item. You can choose
to apply the property only when the workspace or script is used to create a record, only when it is used to open an
existing record, or both.
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Note:  Multi-edit workspaces do not include the option to apply the Required or Hidden properties when
creating new records, since these workspaces are not used when creating records.

You can also apply these properties to the item on a per-prole basis, allowing you to use the same workspace or script
for several proles if you want dierent proles to have dierent seings for these properties. For example, you can
create a workspace that includes elds showing contacts’ phone numbers and addresses. You can then set the Hidden
properties by prole so the elds are shown to sta members with one prole, but are not visible to sta members with
a dierent prole.

Set the Read–Only Property  
This procedure uses the Read–Only property as an example, but applies to the Hidden and Required properties as well.

1. From the open workspace, click the item you want to make Read–Only.
2. Click the Design tab and click Read–Only.
3. To make the item read–only for all proles when creating a new record, select On New.
4. To make the item read–only for all proles when opening an existing record, select On Open.
5. To make the item read–only on a per-prole basis, select Prole–Based. The prole selection window opens.

a. Select the check boxes in the On New column next to the proles you want to apply the property to.
Proles you select will have read–only access to the item when sta members with the prole use the
workspace or script to create a new record.

b. Select the check boxes in the On Open column next to the proles you want to apply the property to.
Proles you select will have read–only access to the item when sta members with the prole use the
workspace or script to open an existing record.

6. Click OK.
7. Click Save.

Considerations for Seing Hidden and Read-Only Properties for Required Fields  
You can set the Hidden and Read–Only properties for required elds when the combination of properties does not
prevent a required eld from being set. However, aempting to set certain combinations of the Hidden and Read–Only
properties on required items is not allowed.

When seing these properties for required elds, you should consider the following limitations.

• Standard elds that are required for a workspace, such as the Contact eld on incident workspaces, cannot
have their Required properties disabled or Read–Only properties enabled for new records.

• If you set a eld property to Read–Only for new records, you cannot also enable the Required property for new
records.

• If you set a eld to be hidden when creating a record, you cannot also enable the Required property when
creating a record.

• If you set a eld to be required when opening a record, you can set the Hidden property for that eld to any
value.

• If you set a eld to be required when creating a record, you can enable the Hidden property when opening an
existing record.

• If you set a eld to always be required, you can enable the Hidden property when opening an existing record.

• If you set a eld to always be required, you can enable the Hidden property when creating a record if you also
set a default value for the eld on the design space. See Considerations for Using the Default Value Property.
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Design Property Descriptions  
When editing elds or controls that you add to a workspace or script, you can adjust dierent properties depending on
the element you select. When you add an item to the design space, you can select it and then edit its properties using
the options available on the Design tab.

The options on the Design tab are organized by groups and described in the following sections. Not all groups are
available for all elements on workspaces or scripts.

• Selected Object Properties

• Behavior Properties

• Label Properties

• Layout Properties

• Options Properties

Note:  For the sake of simplicity, descriptions that refer to elds may also apply to controls and relationship
items.

Selected Object Properties  
The options in the Selected Object group let you select the element to edit and delete. Options for tab controls are also
available here.

Property Description

Current Selection
 

This eld shows the name of the item currently selected on the design space.
 
Click this drop-down menu to view a tree listing the elds and controls currently on the design space.
You can select items from the tree to edit them using the options on the Design tab.
 

Show Details
 

Click this buon to display a list of properties and corresponding values for the selected item.
 

Delete
 

Click this buon to delete the item currently selected on the design space.
 

Add Tab
 

Click this buon to add a tab. This buon displays only when a tab set is selected.
 

Add Tab After
 

Click this buon to add a new tab after the tab that is currently selected.
 

Add Tab Before
 

Click this buon to add a new tab before the tab that is currently selected.
 

Move Left
 

Click this buon to move the tab that is currently selected one position to the left.
 

Move Right
 

Click this buon to move the tab that is currently selected one position to the right.
 

Tab Indexes
 

Click this buon to dene the order in which the elds and controls on the currently selected tab can be
tabbed through using the keyboard Tab key.
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Property Description

Set Child Tab Indexes from Top to Boom
 

Select this option to start the tabbing sequence with the upper left item on the selected tab, proceed
down to the end of the column, continue at the top of the next column, and so on, ending with the item
at the lower right.
 

Set Child Tab Indexes from Left to Right
 

Select this option to start the tabbing sequence with the upper left item on the selected tab, proceed
across to the end of the row, continue at the left of the next row, and so on, ending with the item at the
lower right.
 

Behavior Properties  
The options in the Behavior group let you modify read-only, required, and hidden properties for the selected element.
You can also change the tab order of the selected element.

Property Description

Read Only
 

Click this buon to specify when this property should be applied to the selected element.
 

• On New—The item will be read-only when the workspace or script is used to create a new record.
Multi-edit workspaces do not have this option.

• On Open—The item will be read-only when the workspace or script is used to open an existing
record.

• Prole Based—The item will be read-only for sta accounts using selected proles. Each prole
can have dierent On New and On Open options applied.

See How You Set Hidden, Required, and Read-Only Properties.
 
The Read Only property cannot be set to On New if the object Required property is also set to On New
for any or all proles, and a default value is not set for the object.
 

Required
 

Click this buon to specify when this property should be applied to the selected element.
 

• On New—The item will be required when the workspace or script is used to create a new record.
Multi-edit workspaces do not have this option.

• On Open—The item will be required when the workspace or script is used to open an existing
record.

• Prole Based—The item will be required for sta accounts using selected proles. Each prole
can have dierent On New and On Open options applied.

See How You Set Hidden, Required, and Read-Only Properties.
 
Oracle Service Cloud requires certain elds for certain record types. These elds are automatically set
to On New and On Edit, and the property is disabled so that you cannot change it.
 

Hidden
 

Click this buon to specify when this property should be applied to the selected element.
 

• On New—The item will be hidden when the workspace or script is used to create a new record.
Multi-edit workspaces do not have this option.

• On Open—The item will be hidden when the workspace or script is used to open an existing
record.

• Prole Based—The item will be hidden for sta accounts using selected proles. Each prole can
have dierent On New and On Open options applied.

663



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

Property Description

See How You Set Hidden, Required, and Read-Only Properties.
 
Required elds cannot be hidden when creating records.
 

Tab Order
 

Click this buon to dene the order in which the elds and controls can be tabbed through on the
parent table of the workspace or script, using the keyboard Tab key. You can manually specify the tab
order value for each item or you can assign the tab order automatically.
 

Set Parent Table’s Tab Indexes from Top to
Boom
 

Select this option to automatically assign tab order values for all items. When you select this option,
 the tab ordering will start with the upper left item on the parent table, proceed down the column, then
continue at the top of the next column, ending with the item at the lower right.
 
This selection will reset any numerical ordering that has been dened using the Value property.
 

Set Parent Table’s Tab Indexes from Left to
Right
 

Select this option to automatically assign tab order values for all items. When you select this option,
 the tab ordering will start with the upper left item on the parent table, proceed across the row, then
continue at the left of the next row, ending with the item at the lower right.
 
This selection will reset any numerical ordering that has been dened using the Value property.
 

Value
 

Enter a value in the property to customize the order in which elds and controls can be tabbed through
on the workspace or script. The rst eld or control is 0, and each subsequent press of the Tab key
steps through the items in numerical order.
 
By specifying a numerical order, you can dene whatever tab sequence you want. However, for ease of
use, it is usually best to follow the order of the elds and controls as they are arranged on the design
space.
 

Label Properties  
The options in the Label group let you adjust the fonts and placement of labels for elds you add to your workspace or
script.

Property Description

Font
 

Select the font you want to use for the label from this drop-down menu.
 

Font Size
 

Select the font size you want to use for the label from this drop-down menu.
 

Bold/Underline/Italic/Strikethrough
 

Click these buons to change font style aributes for the label.
 

Font Color
 

Select the font color you want to use from this drop-down menu.
 

Background Color
 

Select the background color you want to use from this drop-down menu.
 
This option is enabled when editing an element that has a background, such as the panel control.
 

Align Text Left/Center/Right
 

Click these buons to move the label to the leftmost, center, or rightmost side of the available space for
the label.
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Property Description

 

Label Position
 

Click this drop-down menu to select the label position in respect to the eld. You can position the label
at the right, left, top, or boom of the eld. The default label position is to the left of the eld.
 

Text
 

Click this buon to change the text for the label of a eld or control. When changing the label for a
control, such as a tab, a text box will display. Enter the text you want for the label in the text box and
press Enter.
 
When changing the label for a eld, the label will be highlighted when you click the Text buon and you
can edit the label on the design space. You can also click the label on the design space without clicking
the Text buon.
 
To allow the use of shortcut keys (Alt + <selected character>), enter an ampersand (&) in front of the
character you want to be the shortcut key. For example, to allow sta members to move the focus to a
control with the label “Details” by pressing Alt+T, enter De&tails.
 

Note:  Text elds used in scripts are limited to 1,000 characters.

Layout Properties  
The options in the Layout group let you change the padding, margins, and height of workspace or script elements. You
can also increase or decrease the number of rows or columns used by the selected element.

Property Description

Table Cell
 

Click this buon to change the number of rows or columns used by the eld or control on the design
space.
 

Increase/Decrease Row Span
 

Select these options to increase or decrease the number of table rows used by the selected eld or
control. The number of rows used is increased or decreased by one each time this option is selected.
 

Increase/Decrease Column Span
 

Select these options to increase or decrease the number of table columns used by the selected eld
or control. The number of columns used is increased or decreased by one each time this option is
selected.
 

Position
 

Click this buon to select the position of the selected object on the table cell that contains it. You can
also select options to stretch the object on the table cell.
 

Padding
 

Click this buon to dene the amount of space between the boundaries of the selected control and its
contents on the left, top, right, and boom. For example, you can specify that the text in a panel will
begin 50 pixels below the top of the panel.
 
The available options are None, Narrow, Medium, Wide, and Custom. Select Custom to dene a specic
number of pixels to use for the top, boom, left, and right padding.
 

Margin
 

Click this buon to dene the amount of space between the selected control and other elds and
controls on the left, top, right, and boom.
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The available options are None, Narrow, Medium, Wide, and Custom. Select Custom to dene a specic
number of pixels to use for the top, boom, left, and right margins.
 

Size
 

Click this buon to specify the size of the selected control. For some controls, you can select Enable
Auto Sizing to automatically adjust the control height and width to its natural size. If you disable auto
sizing, you can enter the height and width (in pixels) of the eld or control on the workspace.
 
On some elds and controls, the MultiLine or Set Fixed Height properties on the Design tab Options
group must be enabled before you can edit the Height property.
 

Options Properties  
The properties you can edit on the Options group depend on the element you select.

Property Description

Accepts Return Select this check box if you want sta members to be able to press Enter in a multi-line eld.
 

Accepts Tab Select this check box if you want sta members to be able to tab to the eld.
 

Activity Position Click this buon to set the position of the activity status indicator on the Chat Transcript Control
relationship item.
 

Allow Delete Select this check box to allow agents to delete les that have been aached and saved to a record. If
this check box is not selected, aached les can be deleted only if the Save buon has not yet been
clicked.
 

Allow Multiple Selections Select this check box to allow agents to select more than one item in a list box control.
 

Allow Tab Reordering Select this check box to allow sta members to drag and reorder the tabs of the selected tab set. If this
check box is not selected, the tabs cannot be reordered by sta members.
 

Always Show Parent with Visible Child Select this check box for a hierarchal menu to display parent items in cases where the parent is hidden
but one or more of its children are visible. A parent displayed in this manner cannot be selected.
 

Anonymous Select this check box to permit survey responses to be entered when a valid contact is not associated
with the record being viewed. This option is available only if the survey allows anonymous responses.
 

Answer ID Click this buon and enter an answer ID for an Answer Display control.
 

Auto Ellipsis Select this check box if you want an ellipsis (…) automatically added when the text of the title bar
exceeds the space allocated to it.
 

Auto Scroll Control Position Click this buon to set the position of the auto scroll control on the Chat Transcript Control relationship
item.
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Property Description

Border Style Click this buon to select a border style for the selected table control. The available options are None,
 Fixed Single, and Fixed 3D.
 

Background Image URL Click this buon and enter a URL for an image you want to display in the table background on the
Agent Browser UI.

Can Assign to Group Select this check box to permit sta members to assign the record to a group rather than a specic
sta member. If this check box is not selected, sta members must assign the record to a sta member
within a group.
 

Cell Border Style Click this buon to select a border style for the cells in the selected table control. The available options
are None, Single, Inset, Inset Double, Outset, Outset Double, and Outset Partial.
 

Control Context Click this drop-down menu and select an option that controls how names in the Assigned eld for
tasks are grouped. The options are:
 

• Default—Names are displayed in a at alphabetical list.

• Sales—Names are displayed by Manager hierarchy.

• Incident—Names are displayed by Group hierarchy.

• Answer—Names are displayed by Group hierarchy.

• Organization—Names are displayed by Manager hierarchy.

• Campaign—Names are displayed by Group hierarchy.

• Document—Names are displayed by Group hierarchy.

• Mailing—Names are displayed by Group hierarchy.

• Survey—Names are displayed by Group hierarchy.

Default Channel Click this buon to dene the default channels for customer entries and notes.
 

Default Channel for Customer Entry Select the default channel to use for the customer’s entry on a record from this list. Options include No
Default, Phone (the default value), Fax, Post, Web, and Email.
 

Default Channel for Note Select the default channel to use for the note on an incident, contact, organization, or opportunity from
this list. Options include No Default, Phone, Fax, Post, Web, and Email.
 

Default Font Click a drop-down menu from this buon group to select a default font and font size for the Rich Text
Incident Thread control.
 

Default Notication Action Click this buon to specify when to notify subscribers when an answer is updated. Options include No
Change, Do Not Notify, Hourly, Daily, Weekly, and Monthly.
 

Default Phone Type Click this buon to select the default phone type that should be displayed on the workspace. For
example, you can choose Oce Phone or Mobile Phone.
 

Default Thread Click this buon to dene the default thread type for new incidents or incidents being edited.
 

Default Thread on Edit Click this drop-down menu and select an option to dene the default thread for an incident being
edited. Options include No Default, Private Note, Response (the default value), and Customer Entry.
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Property Description

 

Default Thread on New Click this drop-down menu and select an option to dene the default thread for a new incident.
Options include No Default, Private Note, Response, and Customer Entry (the default value).
 

Default Value Click this buon and select From Workspace or From Script if you want to specify a default value for
a eld. When this option is enabled, you can edit the eld on the design space to specify the default
value that will be used when the workspace or script is used to create a record. The value can be
changed by sta members who have permission to edit the eld. See Considerations for Using the
Default Value Property.
 
The default value is applied only to new records created in the workspace or script. Records that were
created from other channels, such as the Ask a Question page, are not impacted.
 

Delay Page Load Select this check box to prevent the web page specied in the browser control from loading until the
tab the control is on is selected. When this option is disabled, the web page will load as soon as the
workspace or script opens, even if the browser control is not initially displayed.
 
If the browser is visible when the workspace or script page is opened (for example, it appears on the
top tab), it will always open immediately even if this property is enabled.
 

Disable Email Icon Select this check box to disable the Send Email envelope buon that appears next to the Email
Addresses eld. When this check box is cleared, clicking the Send Email buon opens the contact email
address in a new message in the workstation default mail client, outside of Oracle Service Cloud.
 

Display Options Click this buon to select toolbar options for the Chat Control relationship item.
 

Show Toolbar Select this option to display the Chat Control toolbar.
 

SmartAssistant Select this option to display the SmartAssistant buon on the Chat Control toolbar.
 

Search Knowledgebase Select this option to display the Search Knowledgebase buon on the Chat Control toolbar.
 

Standard Text Select this option to display the Standard Text buon on the Chat Control toolbar.
 

Display Style Click this drop-down menu to select the display style for a Yes/No eld on the Agent Browser UI.
Options include Drop-down Menu, Checkbox, Radio Buons, and Switch.

Enable Collapse/Expand Select this check box to let users expand and collapse the table display in the selected workspace on
the Agent Browser UI.

Filter Type Click this buon to select lter options for custom object or system aribute menus that are populated
by the Accounts by Group or Accounts by Manager menu. The option you select will be used to lter
the accounts listed in the menu based on account status. Available options include All Accounts,
 Enabled Accounts, or Accounts Enabled for Assignment.
 

Hide Options Buon Select this check box to prevent the Options buon from displaying on a report control or relationship
item that contains the Options buon (such as Contacts, Time Billed, and Audit Log) in a workspace or
script. The Options buon is displayed by default.
 
If this check box is selected when there are no commands on the toolbar or the Hide Report Command
option is also selected, the entire toolbar will be hidden.
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Hide Report Commands Select this check box to hide and disable the report commands (New, Open, Copy, Delete, Print,
 Forward, Assign, and Propose) on the workspace.
 

Image Click this buon to select the image you want to place on buon or image controls. See Workspace and
Script Buon and Image Controls.
 

URL Click this drop-down to enter an image URL to display an image from a URL.

Note:  The image URL will display only on workspaces on the Agent Browser UI.

Image Align Click this buon to position an image added to a buon in relation to the buon text. See Workspace
and Script Buon and Image Controls.
 

Image Layout Click this buon to select how you want the buon or image control sized. See Workspace and Script
Buon and Image Controls.
 

Increment Enter a number that denes the value an integer eld is increased or decreased when the up or down
arrow is clicked. The default value is 1.
 

Layout Click this buon to select whether the items in an option control are displayed vertically or horizontally.
 

Legacy Status Mode Click this buon to enable the legacy status indicator on the Chat Transcript Control relationship item.
 

Limit By Prole Interface(s) Click this buon to limit products and categories displayed on the Products and Categories relationship
item to those that have administration visibility on the interfaces to which the sta member’s prole
has access.
 

Locale Click this buon to select a locale for the Policy Automation control. For information about Oracle
Policy Automation, see Oracle Applications Integrations with Oracle Service Cloud.
 
To enable Oracle Policy Automation with Oracle Service Cloud, contact your Oracle account manager.
 

Max Length Click this buon and enter the maximum number of characters the eld can contain. You can enter
values from 1 to 4,000.
 

Minimum Level Click this buon and enter the minimum number of levels of products, categories, or dispositions that
sta members must enter when working on incidents. The acceptable range is between 0 and 6.
 

Multiline Select this check box to allow multiple lines in the eld. If this option is not enabled, the eld will be
restricted to a single line.
 

No Time Portion Select this check box to hide the time portion of date/time elds, such as the Date Created eld.
 
If this option is selected for elds that can be edited, sta members will not be able to enter exact
times. You may want exact times for reporting purposes.
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Open Pop-ups in New Browser Control Select this check box to open windows from the browser content in child browser controls. When this
option is not selected, the control will ll the maximum allowed space.
 
If this check box is not selected, pop-ups will open in a full Internet Explorer browser, which can cause
session variables to be lost. To ensure session variables are maintained, select the check box.
 

Password Cover Enter the character you want to use to hide the password when it is entered on the workspace. The
default is an asterisk (*).
 
This option is available for use with the organization password eld. You cannot add the contact
password eld to workspaces.
 

Permissions Click this buon to manage individual options available on the Rich Text Incident Thread control.
 
All permissions—except Always Default to Plain Text and Always Use Plain Text—are selected by
default. Also, these permissions are enforced only for sta members using the workspace, and do not
aect actions performed by workow or script rules.
 

Follow Links Select this option to allow agents to navigate to a linked URL in a web browser when they click the
link in a commied thread. When this option is not selected, the function is not available and an error
message is displayed when the agent clicks a link in a commied thread.
 

Follow Incident Reference # Links Select this option to allow agents to open an incident when they click the incident reference number in
a commied thread. When this option is not selected, the function is not available.
 

Allow Using Send On Save Select this option to display the Send On Save check box on the Messages tab toolbar on an incident
thread. When this option is not selected, the check box is hidden.
 

Allow Using SmartAssistant Select this option to display the SmartAssistant buon on the Messages tab toolbar on an incident
thread. When this option is not selected, the buon is hidden.
 

Allow Using Search Knowledgebase Select this option to display the Search Knowledgebase buon on the Messages tab toolbar on an
incident thread. When this option is not selected, the buon is hidden.
 

Allow Adding Standard Text Select this option to display the Standard Text buon on the Messages tab toolbar on an incident
thread. When this option is not selected, the buon is hidden.
 

Allow Toggling Thread Content to Plain
Text

Select this option to allow an agent to switch between using Plain Text and Rich Text format modes in
incident thread entries.
 
When this option is selected, the Always Use Plain Text option is cleared.
 

Always Default to Plain Text Select this option to use Plain Text format mode for a new incident thread entry.
 
When this option is selected, agents will be able to switch to Rich Text format mode if the Allow
Toggling Thread Context to Plain Text option is also selected.
 

Always Use Plain Text Select this option to allow only Plain Text format mode in incident thread entries. The Rich Text format
mode will not be available to agents.
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When this option is selected, the Allow Toggling Thread Content to Plain Text option is cleared and the
Always Default to Plain Text option is selected.
 

Allow Adding Responses Select this option to enable the Response item in the Add buon drop-down menu on the Messages
tab toolbar. When this option is not selected, the Response item is not displayed.
 
At least one of Allow Adding Responses, Allow Adding Customer Entries, or Allow Adding Notes
options must be selected for the Add buon to display on the Messages tab toolbar.
 

Allow Adding Customer Entries Select this option to enable the Customer Entry item in the Add buon drop-down menu on the
Messages tab toolbar. When this option is not selected, the Customer Entry item is not displayed.
 
At least one of Allow Adding Responses, Allow Adding Customer Entries, or Allow Adding Notes
options must be selected for the Add buon to display on the Messages tab toolbar.
 

Allow Adding Notes Select this option to enable the Private Note item in the Add buon drop-down menu on the Messages
tab toolbar. When this option is not selected, the Private Note item is not displayed.
 
At least one of Allow Adding Responses, Allow Adding Customer Entries, or Allow Adding Notes
options must be selected for the Add buon to display on the Messages tab toolbar.
 

Allow Adding CC Recipients Select this option to allow display of the CC eld in the Response title bar when the Send on Save check
box is selected by an agent. The agent can show or hide the CC eld by clicking the Options buon on
the Messages tab toolbar and selecting or clearing the Show CC check box.
 

Allow Adding BCC Recipients Select this option to allow display of the BCC eld in the Response title bar when the Send on Save
check box is selected by an agent. The agent can show or hide the BCC eld by clicking the Options
buon on the Messages tab toolbar and selecting or clearing the Show BCC check box.
 

Policy Model Click this buon to select a policy model to display on the Policy Automation control. For information
about Oracle Policy Automation, see Oracle Applications Integrations with Oracle Service Cloud.
 
To enable Oracle Policy Automation with Oracle Service Cloud, contact your Oracle account manager.
 

Refresh When New Record is Saved Select this check box to refresh the Policy Automation control when a new record is saved. For
information about Oracle Policy Automation, see Oracle Policy Automation Cloud Service.
 

Report Click this buon to open the Select Report window to select a report for the control. See How You Add
Reports and Relationship Items to Custom Workspaces and Scripts.
 

CAUTION:  The Select Report window displays all reports, not just those that apply to the
selected workspace. Be sure to select a report that applies to the workspace. For example,
 do not select an opportunity search report to appear in the Organization eld of a contact
record.

Report Behavior Click this buon to congure report behavior properties. See Report Properties.
 

Required for Solved/Waiting Select this check box if sta members must select a value for the item before they can set a record
status to Solved or Waiting.
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Response Options Click this buon to select options for the Rich Text Incident Thread control on incident workspaces or
the Chat Control control on chat workspaces.
 

Allow Encoding Choice Select this option to allow agents to choose between rendering chat comments as HTML or plain text.
 

Always Leave as Plain Text Select this option to always render chat comments as plain text.
 

Always Send as HTML Select this option to always render chat comments as HTML.
 

Conrm Response When Saving and Send
On Save is Selected

Select this option if you want the sta member to conrm that the incident response should be sent.
 

Commit Response When Incident is Saved Select this option if you want the sta response to be commied to the incident thread when the
response is saved.
 

Add a Response When Selecting Send On
Save if No Response Already Exists

Select this option to automatically display the response options panel when you select the Send on
Save check box on the Rich Text Incident Thread control. Clearing the check box closes the response
options. Additionally, when this property is enabled, clicking the slider on the Messages tab to open the
response options panel automatically selects the Send on Save check box, and closing the response
options clears the check box.
 
If this option is disabled, then expanding the response options panel enables the Send on Save check
box, but clicking the Send on Save check box does not automatically expand the panel. Clearing
the Send on Save check box automatically collapses the panel, but collapsing the panel does not
automatically clear the Send on Save check box.
 

Always show email message header for
responses

Select this option if you want the email message header to always display when the response is sent.
 

Reassign the Incident When Send On Save
is Selected

Click this drop-down menu and select one of the following options for reassigning an incident when a
response is sent.
 

• No Change—The incident Assigned eld does not change.

• To Current Agent—The Assigned eld changes to the sta member working the incident.

• To Unassigned—The Assigned eld is set to No Value.

Automatically Select Send On Save When
Opening an Incident

Click this drop-down menu and select an option that indicates when an incident response should be
sent automatically. The options are:
 

• Never—A response is never sent automatically.

• On New—A response is sent for a new incident.

• On Edit—A response is sent when an incident is edited.

• On New and Edit—A response is sent whenever an incident is added or edited.

To automatically select the Send on Save check box only when sending a response, an agent can click
the slider bar at the left of the incident thread and enter the response using the response options
section.
 
This option is not supported on the Agent Browser UI.
 

Change the Incident’s Status when Send
On Save is Selected

Click this drop-down menu and select an option for changing the incident status when a response is
sent. The options are:
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• No Change—The incident status does not change when a response is sent.

• To Waiting—The incident status changes to Waiting when a response is sent.

• To Solved—The incident status changes to Solved when a response is sent.

RNT Mask Click this buon to view the mask for the selected custom eld. Standard elds do not have mask
properties.
 
See Input Masks for information about specifying masks for custom elds.
 

Script Click this buon to open the Select a Script window to change the script used in a script control. See
Add a Script Control to the Design Space.
 

Search Report Click this buon to open the Select Report window to select a search report. See How You Add Reports
and Relationship Items to Custom Workspaces and Scripts.
 
This property is used for items that include a search report, such as the Contacts, Tasks, Guided
Assistance, and Custom Object View relationship items.
 

Secondary Search Report Click this buon to open the Select Report window to select a secondary search report. See How You
Add Reports and Relationship Items to Custom Workspaces and Scripts.
 
This property is used for relationship items that can include a secondary search report, such as the
Contacts and Tasks relationship items.
 

Set Fixed Height Select this check box to enable the Height layout property. When this option is not selected, the control
will ll the maximum allowed space.
 

Show Categories Click this buon to show or hide the categories tree on the Products and Categories relationship item.
The categories tree is visible by default.
 

Show Image Select this check box to display the paper clip icon for le aachment and quote controls when les are
aached to the record.
 

Show Navigation Select this check box if you want the workspace to display the navigation controls for the selected
guide.
 

Show Parent Select this check box if you want the workspace to display the parent of the selected item (for example,
 a sta account’s group in the Assigned eld or the main product for a subproduct).
 

Show Products Click this buon to show or hide the products tree on the Products and Categories relationship item.
The products tree is visible by default.
 

Show Row Count Select this check box to display the number of records in a report. The number is displayed in
parentheses next to the tab title.
 

Show Search Buon Select this check box to add the Search for a Guide buon on the Guided Assistance relationship item.
Clicking this buon on a workspace opens a window where you can enter search criteria to nd the
guide you want. See Guided Assistance Relationship Item.
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If this check box is not selected on the workspace designer, the Search window can still be opened
from a ribbon buon on the workspace.
 

Show Search Inline Select this check box to display search elds on the workspace to search for a guided assistance guide.
See Guided Assistance Relationship Item.
 
Selecting this check box prevents the Search for a Guide and Select a Guide buons from displaying on
the workspace, though these can still be accessed from a ribbon buon.
 

Show Select Buon Select this check box to add the Select a Guide buon on the Guided Assistance relationship item.
Clicking this buon on a workspace opens a window where you can select the guide you want from a
list of available guides. See Guided Assistance Relationship Item.
 
If this check box is not selected on the workspace designer, the Search window can still be opened
from a ribbon buon.
 

Siblings Visible Click this drop-down menu and select True if you want the File Aachments controls to display
information for the answer and all the answer siblings. Select False if you want to display only the
information for the answer.
 

Sort Provinces Alphabetically Select this check box if you want the State/Province eld to display in alphabetical order on the
Address control. Clear this check box to display states and provinces in the sequence specied on the
Countries editor. See Add or Edit a Country or Province.
 

Spell Check Select this check box to enable spell checking for the eld or object when the workspace is spell
checked.
 

Spell Check (for the Rich Text Incident
Thread control)

Click this drop-down menu and select a spell check option from the following list.
 

• True—The eld spelling is checked when a sta member clicks the Spell Check buon on the
ribbon.

• False—The eld spelling is never checked.

• As You Type—The eld spelling is checked automatically as the sta member enters information.

Summary Panel Alignment Click this buon to select if the Summary Panel will appear as the rst tab in the tab set or as a
persistent panel above the tab set. Options are First Tab or Top. The default value for a new workspace
is Top.
This buon is only available when the workspace primary tab set is selected. This property is applicable
only when a workspace is used on the Agent Browser User Interface.
 

Note:  When enabled on an incident workspace on the Agent Browser UI, the summary panel
displays above the tab set containing summary information about the incident.

Summary Panel Height Click this buon to enter the height of the summary panel in pixels.
 
This buon is available only when the workspace primary tab set is selected.
 

Suppress Errors and Authentication
Dialogs

Select this check box to suppress any warning prompts (such as script errors and authentication
requests) that may occur in the browser control when a URL is loaded.
 

Survey Click this buon to select a survey for the Survey by Proxy control.
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Tab Alignment Click this buon to select where you want tab sets placed on the dashboard. The available options are
Left, Right, Top, and Boom.
 

Tab Display Style Click this drop-down menu and select a tab display style option from the following list.
• Regular—Displays the selected tab set as the default, horizontal style.

• Accordian Single Open—Displays the selected tab set as an accordion with only the selected tab
open. When a dierent tab in the tab set is open, the previous open tab will close.

• Accordion Multiple Open—Displays the selected tab set as an accordion, allowing for multiple
tabs to remain open.

Note:  The accordion tab set display applies only to workspaces on the Agent Browser UI.

Thousands Separator Select this check box to add a thousands separator to an integer when the value is entered on a
workspace (for example, “10000” becomes “10,000”).
 

Thread Display Click this drop-down menu and select Show Thumbnails and then specify the number of threads
that will display on the incident workspace. The incident threads will display as thumbnails once the
specied threshold is met.
 
The maximum incident threshold value is 99.
 

Thread Orientation Click this drop-down menu to select a thread orientation for the Rich Text Incident Thread control.
The available options are Vertical, Horizontal, or Horizontal with Splier. By default, a vertical thread
orientation is used.
 

Threshold Height Click this buon to enter the threshold height for the summary panel in pixels. If the space available for
the summary panel is less than this value, the summary panel becomes the rst tab on the tab set.
 
The minimum value of the threshold height is 100 pixels greater than the value specied in the
Summary Panel Height control.
 

Time Limit Click this buon to select the maximum amount of time that the report specied in the report control
should take to generate. You can select a value up to 240 seconds. Specifying a time limit can improve
performance since workspaces are unavailable until reports on the workspace generate. Reports that
take longer than the specied time limit to generate will not be displayed on the workspace. See Set a
Time Limit for a Report Control.
 

Time Required Click this buon to select time requirements. This property is used with the Time Billed control.
 

Time Required for Edit Select Time Required for Edit if you want sta members to be required to add a time billed entry each
time they edit an incident.
 
An entry will not be required if the Time Billed relationship item is hidden on the workspace.
 

Time Required for Solved Select Time Required for Solved if you want sta members to be required to add a time billed entry
each time they solve an incident.
 
An entry will not be required if the Time Billed relationship item is hidden on the workspace.
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Timer Position Click this buon to set the position of the timer status indicator on the Chat Transcript Control
relationship item.
 

Trim Whitespace Select this check box to trim leading and trailing white space on text elds.
 

Up Down Align Click this drop-down menu and select Left to position the up/down arrows (for incrementing an
integer eld) on the left side of the eld. Select Right to place the arrows on the right.
 

URL Enter the URL that should be accessed when the browser control is accessed on the workspace. You
can also open les on your workstation or network by specifying a format of le://<le path>.
 
For information about passing variables through this URL, see Workspace and Script Browser Controls.
 

Visible Select this check box if you do not want the ag control on the workspace to be visible.
 

Wrap Tabs Select this check box if you want tabs in a tab group to wrap across multiple lines when there is
insucient space to display them all on a single line. Clear this check box if you want the tabs to be on
a single line, requiring tab scrolling.
 

Wrap Text Select this check box to wrap the label text if needed to t the label in the space provided.
 

Ribbon and Quick Access Toolbar Buons  
When designing a workspace, or a script that will be used in a workow, you can select which buons to place on the
ribbon, the Quick Access toolbar, and the Actions drop-down menu (for the Agent Browser UI).

Most of the buons you can place on the ribbon can also be placed on the Quick Access toolbar. Sta members see only
the buons you select, which vary by the type of workspace or script you are creating. In addition, if you are conguring
workspaces for the Agent Browser UI, you will congure the Actions drop-down using the ribbon conguration.

Note:  Ribbon and Quick Access toolbar conguration options are available for scripts only when desktop
workows are enabled for your site. Contact your Oracle account manager to enable desktop workows.

The ribbon buons available vary by workspace type. Buons available to each script type are the same as those
available to the corresponding workspace type, with the exception of the Expand buon, which is not supported by
scripts.

Workspace Type Available Buons

Answer
 

• Check Links

• Copy

• Delete
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Workspace Type Available Buons

• Expand/Collapse

• Info

• Links

• New

• Preview

• Print

• Refresh

• Save

• Save and Close

• Spell Check

• Validate Category Links

Assets
 

• Copy

• Delete

• Expand/Collapse

• Info

• Links

• New

• Refresh

• Save

• Save and Close

• Spell Check

Chat
 

• Add to Incident

• Add to New Incident

• Change Lead Role

• Conference

• Expand/Collapse

• Join

• Leave

• New Opportunity

• Oer Advisor

• Screen Sharing

• Spell Check

• Terminate

• Transfer

• Wrap-up

Contact
 

• Appointment

• Copy
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Workspace Type Available Buons

• Delete

• Expand/Collapse

• Info

• Links

• New

• Print

• Refresh

• Reset Password

• Save

• Save and Close

• Spell Check

Custom Object
 

• Copy

• Delete

• Expand/Collapse

• Info

• Links

• New

• Refresh

• Save

• Save and Close

• Spell Check

Incident
 

• Appointment

• Collaborate

• Copy

• Delete

• Expand/Collapse

• Forward

• Guided Assistance

• Info

• Links

• New

• New Opportunity

• Oer Advisor

• Print

• Propose

• Refresh

• Reset Password

• Save

678



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

Workspace Type Available Buons

• Save and Close

• Send

• Send and Close

• Spell Check

Interaction
 

• Add to Incident

• Add to New Incident

Opportunity
 

• Appointment

• Copy

• Delete

• Expand/Collapse

• Forward

• Info

• Links

• New

• Print

• Refresh

• Reject

• Reset Password

• Save

• Save and Close

• Spell Check

Organization
 

• Appointment

• Copy

• Delete

• Expand/Collapse

• Info

• Links

• New

• Print

• Refresh

• Save

• Save and Close

• Spell Check

Quote
 

• Expand/Collapse

• Info

• Links

• Print
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• Save

• Save and Close

• Send

• Spell Check

Quote Product
 

• Expand/Collapse

• Info

• Links

• Save

• Save and Close

• Spell Check

Task
 

• Appointment

• Complete

• Copy

• Delete

• Expand/Collapse

• Forward

• Info

• Links

• New

• Print

• Refresh

• Reset Password

• Save

• Save and Close

• Spell Check

Multi Edit Workspace
 

• Complete — Only on Task Multi-Edit workspaces

• Expand/Collapse

• Links

• Reject — Only on Opportunity Multi-Edit workspaces

• Save and Close

• Spell Check

• Validate Category Links — Only on Answer Multi-Edit workspaces

Related Topics
• Overview of the Dynamic Agent Desktop

• Edit a Workspace

• Edit a Script
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How You Work with Ribbon and Quick Access Toolbar Buons  
Buons are added and removed from the ribbon and Quick Access toolbar using the ribbon designer.

You can add tabs and tab groups to your ribbon to organize the buons on the ribbon, and you can arrange tabs,
groups, and buons in any order you want. You can also change buon display options to help optimize the ribbon
display. Certain ribbon buons include special features you can use to access record information and links to web pages.

By default, the ribbon and Quick Access toolbar for a new workspace or script contain the same buons as the standard
workspace for the corresponding workspace type. Therefore, it is not necessary to edit the ribbon or Quick Access
toolbar if the standard buons are adequate. Also, if you have made changes, you can restore the default content at any
time by clicking the Reset to Default buon on the ribbon designer window.

Open the Ribbon Designer  
You can customize the ribbon and the Quick Access toolbar by using the ribbon designer.

The top of the ribbon designer features a ribbon preview that shows the tabs, buon groups, and buons currently
on the ribbon as well as the buons on the Quick Access toolbar. The boom part of the ribbon designer includes
a clickable path to the ribbon item currently selected on the preview, design options for customizing the selected
item, and a list of ribbon items editable from the same path. The path, design options, and list change dynamically as
dierent items are selected on the ribbon preview.

For instance, when you select the Save buon group on the default Home tab, the ribbon designer displays the path of
the selected group (Editing Tab: Home), a list of the buon groups currently dened at that location, and design options
for customizing the buon groups. Clicking a group or a buon on the ribbon preview changes the design options and
list to reect the item you have selected.

1. From the open workspace or script, click the Home tab and click Ribbon.

Customize the Ribbon  
Ribbon tabs contain buon groups, which contain buons. You can easily add, remove, or rename any of these items
using the ribbon designer. You can also add vertical separators to organize buons within a group. To select an item you
want to edit, click it on the preview ribbon.

You can right-click items on the ribbon designer to access a list of actions you can take on each item. This gives you a
shortcut to many of the same functions described in the following procedure.

1. To add a tab to the ribbon, click Add Tab on the boom of the ribbon designer.
a. Enter a name for the new tab in the Ribbon Tab Name eld.
b. Click OK.

2. To add a buon group to a tab, click the tab you want to add the group to (either on the ribbon preview or in the
item list).

a. Click Edit Tab.
b. Click Add Group.
c. Enter a name for the new group in the Group Name eld.
d. Click OK.

3. To add a buon to a buon group, click the buon group you want to add the buon to (either on the ribbon
preview or in the item list).

a. Click Edit Group.
b. Click Add Buons to open the Add or Remove Buons window.
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c. Select the check boxes next to the buons you want to add to the buon group.
d. Click OK.

Note:  When adding buons to the ribbon, be sure to include only buons that agents actually need
to use. If a buon group contains numerous buons, you can either create another group to make the
ribbon easier to navigate, or you can edit the group and click Add Separator to add a vertical line to
the group to break up buons in the group.

4. Click OK on the ribbon designer.

Rename a Tab, Group, or Buon  
Use this procedure to rename a tab, group, or buon (either on the ribbon preview or in the item list).

1. To rename a tab, click the tab you want to rename.

Note:  The Home tab cannot be renamed.

a. Click Rename Tab.
The Rename Tab window opens.

b. Enter a new name for the tab in the Tab Name eld.
c. Click OK.

2. To rename a buon group, click the buon group you want to rename.
a. Click Rename Group.

The Rename Group window opens.
b. Enter a new name for the group in the Group Name eld.
c. Click OK.

3. To rename a buon, click the buon you want to rename.
a. Click Rename Buon.

The Rename Buon window opens.
b. Enter a new name for the buon in the Buon Name eld.
c. Click OK.

4. Click OK.

Move Tabs, Groups, Buons, and Separators  
Use this procedure to move items on the ribbon designer.

1. Click the tab, group, buon, or separator you want to move.
2. Click the up or down arrow at the right of the item list to move the item where you want it.
3. Click OK.

Delete Tabs, Groups, Buons, and Separators  
Use this procedure to delete items on the ribbon designer.

CAUTION:  If you delete a tab, all the groups and buons on the tab are also deleted. If you delete a buon
group, all the buons in the group are deleted. The Home tab cannot be deleted.

1. Click the tab, group, buon, or separator you want to delete.
2. Click Delete Tab, Delete Group, or Delete Buon.
3. Click Yes to conrm the deletion.
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Edit Ribbon Buons  
You can edit buons on the ribbon to change their size and to specify if text should be included with the icons.

1. On the ribbon preview, click the buon you want to edit.

Tip:  You can also right-click tabs, groups, and buons on the ribbon preview to access Edit, Delete,
and Rename options.

2. Click Edit Buon to open the Edit Buon window.
3. To select a dierent size for the buon, select Big Buon or Small Buon from the Buon Size drop-down

menu.
4. To select a dierent style for the buon, select Icon and Text or Icon Only from the Buon Style drop-down

menu.
5. Click OK.

Set a Link to a URL on the Links Buon  
You can dene a link to a URL on the Links buon, allowing sta members access to the URLs you specify.

The Links buon is added to the ribbon in the same manner as other ribbon buons. However, this buon has unique
functionality. You can edit the Links buon to create a menu of links to URLs. When sta members click the Links buon
drop-down menu, they will see the list of links you dened. Selecting one of the links takes them to the specied URL.

1. Click Links (either on the ribbon preview or in the item list). See Customize the Ribbon for the procedure to add
buons to the ribbon.

2. Click Edit Buon.
The Edit Links window opens.

3. Select the size of the Links buon from the Buon Size drop-down menu.
4. Select whether to display the buon with an icon and text or only an icon from the Buon Style drop-down

menu.
5. Right-click the link browse tree and select Add Link.
6. Enter the name of the link (what sta members will see on the menu) in the Label eld.
7. Enter the URL in the URL eld that will open when sta members click the link.
8. To remove a link, right-click the link you want to remove and select Remove Link.
9. To add a folder, right-click the link browse tree and select Add Folder.

a. Enter the name of the folder in the Label eld.
10. To add a separator, right-click the link browse tree and select Add Separator.
11. Click OK.

Set Information Options on the Info Buon  
You can dene the information that displays when sta members hover over or click the Info buon.

The Info buon is added to the ribbon in the same manner as other ribbon buons. However, the Info buon has unique
functionality. You can edit this buon to add information about the record being edited on the workspace or script.
When sta members hover over the buon or click it, they can view the information you want to display.

Tip:  To reduce cluer on your workspace, consider conguring the Info ribbon buon to show elds that are
always read only, such as the Date Created and Date Updated elds on an incident.

1. Click Info, either on the ribbon preview or on the boom of the designer. See Customize the Ribbon for the
procedure to add buons to the ribbon.

2. Click Edit Buon.
The Info Item Editor opens.

3. Click the Buon Size drop-down menu to select the size of the Info buon.
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4. Click the Buon Style drop-down menu to select whether to display the buon with an icon and text or only an
icon.

5. Expand the eld tree in the Available Info Fields column and select the elds you want to add to the Info buon.
6. Click the right arrow, located between the Available Info Fields and Selected Info Fields columns, to place the

elds in the Selected Info Fields column.
Fields are displayed on the Info buon in the order they are added.

7. To remove elds from the Info buon, select the elds in the Selected Info Fields column and click the left
arrow, located between the Available Info Fields and Selected Info Fields columns, to remove the elds.

8. Click OK.

Add or Remove Quick Access Toolbar Buons  
You can customize the Quick Access toolbar to add buons that are commonly used by your sta members. For
example, the Save buon is often added to the Quick Access toolbar so records can be saved without having to select a
tab on the ribbon to access the Save buon.

1. Click Congure Quick Access Buons on the Quick Access toolbar on the Ribbon Preview.
The Congure Quick Access Buons window opens.

2. Select the check boxes next to the buons you want to add to the Quick Access toolbar.

Tip:  Buons will appear on the Quick Access toolbar in the order you select them.

3. Clear the check boxes next to the buons you do not want.
4. Click OK.

The buons on the Quick Access toolbar shown on the ribbon designer are updated to reect the changes you made.

Restore Default Content on the Ribbon and Quick Access Toolbar  
After you edit a ribbon, you may decide you want to restore the default content.

The ribbon defaults can be restored at any time. When you restore the defaults, the content on the Quick Access toolbar
is also reset. In addition, buons on the ribbon will be reset to use their default size and style.

1. On the lower left corner of the ribbon designer, click Reset to Default.
2. Click Yes.

Desktop Workows  

Overview of Desktop Workows  
When following elaborate business processes, sta members often evaluate critical information and perform a variety
of actions across multiple records. To promote eciency and reduce the chances for human error, Oracle Service Cloud
lets you create highly customized desktop workows that guide agents through complex customer interactions and
data updates.

A desktop workow is a sequence of workspaces, scripts, decisions, and actions—even other embedded workows
—that supports a business process. Using an intuitive design interface, you dene a workow by assembling a set of
elements into a logical order to form a ow diagram, then adding decision logic to advance the ow.

After you have designed a workow, you can provide sta members access to it by selecting it in place of a workspace
for an editor within their prole. When a record is opened into that editor (an incident, for example), the sta member is
guided dynamically through the workow, starting at the entry point. Events and conditions are evaluated and executed
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in the sequence you have specied. (For instance, when a sta member updates the value of a eld, the workow can
evaluate the update and open a related record in a dierent workspace.)

In this way, you can provide your sta with an environment tailored to their skills and responsibilities. When their
activities are supported by an optimized workow, sta members can worry less about remembering the details of your
complex business processes and focus more on completing them accurately.

Note:  Before designing desktop workows, it is important to rst become familiar with workspaces,
workspace rules, guides, agent scripts, and script rules—and the strengths and benets of each—to beer
understand how workows are used to integrate them. See Overview of the Dynamic Agent Desktop.

Desktop Workow Design Canvas and Ribbon  
When editing a desktop workow, you perform most tasks using the ribbon and canvas. These resources provide all of
the tools and elements you need to design any workow, simple or complex.

The workow design ribbon includes three standard tabs (Home, Insert, and View) as well as two contextual tabs
(Element Tools and Path Tools) that become visible when an element or connector is selected. Each tab has one or more
groups containing buons you can use to modify the desktop workow or its elements on the canvas.

Desktop Workows Home Tab  
The Home tab gives you access to options that impact the entire desktop workow. For example, you can select
workow elements, perform basic editing functions, add notes, and validate and preview the workow.

Group/Buon Description

Designer The buons in this group provide access to basic design functions.

Preview Click this buon to preview the desktop workow. See Preview a Workow.

Audit Log Click this buon to view a history of all actions taken on the desktop workow, such as when it was
created and edited and by whom.

Notes Click this buon to add notes about the desktop workow.

Clipboard The buons in this group provide access to basic editing commands when working with components
on the canvas.
Clipboard functions are restricted to the open workspace. They cannot be used to copy elements from
one workow to another.
 

Paste Click this buon to paste the contents of the clipboard.

Cut Click this buon to cut selected elements from the canvas to the clipboard.

Copy Click this buon to copy selected elements from the canvas to the clipboard.

Delete Click this buon to delete selected elements from the canvas.

Elements The buons in this group let you add elements to your ow diagram. For a description of available
elements, see How You Design a Flow Diagram.
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Group/Buon Description

Elements can also be accessed from the Insert tab.
 

Validate Click this buon to check the ow diagram for errors. See Workow Validation.

Desktop Workows Insert Tab  
The Insert tab lets you add components to your ow diagram, either one at a time or in predened workow templates.

Group/Buon Description

Template The buons in this group let you select a predened ow template to apply to your desktop workow.
See Apply a Workow Template.

CAUTION:  When you add a template, any content you previously added is deleted from the
canvas.

New vs. Edit Hover over this buon to see a preview of the New vs. Edit workow template. Click the buon to add
the template to the canvas. See New vs. Edit Workow Template.

Add Task Hover over this buon to see a preview of the Add Task workow template. Click the buon to add the
template to the canvas. See Add Task Workow Template.

Copy Incident Hover over this buon to see a preview of the Copy Incident workow template. Click the buon to add
the template to the canvas. See Copy Incident Workow Template.

Create Contact Hover over this buon to see a preview of the Create Contact workow template. Click the buon to
add the template to the canvas. See Create Contact Workow Template.

Elements The buons in this group let you select elements to add to your ow diagram. For a description of
available elements, see How You Design a Flow Diagram.
Elements can also be accessed from the Home tab.
 

Desktop Workows View Tab  
The View tab provides options for changing your view of the design canvas.

Group/Buon Description

Canvas The seings in this group let you select canvas options.
Oracle Service Cloud remembers any changes you make to these seings to give you a consistent,
 personalized design experience.
 

Element Labels Select this check box to display labels for elements in the diagram. Name labels are displayed by
default.
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Group/Buon Description

Connector Labels Select this check box to display labels for connectors in the diagram. Labels are displayed by default.

Validation Results Select this check box to display validation icons in the diagram. Validation results are hidden by default.
See Workow Validation.

Working Record Select this check box to display working record labels for elements in the diagram. Labels are displayed
by default.

Grid Select this check box to display the design grid. The grid is displayed by default.

Grid Size Click this drop-down menu to select the size of the canvas grid.

Zoom The buons in this group let you select a zoom level for the canvas.

Zoom Click this buon to access the Zoom Options window. See Set Zoom Options.

100 percent Click this buon to view the canvas at its normal size.

Fit To Screen Click this buon to adjust the zoom level to show all elements.

Extents Click this buon to show the entire canvas.

As described in the previous table, you can change the view of the design canvas from the View tab to more easily
review and edit your ow diagram. Included in these controls is the ability to adjust the zoom level.

Set Zoom Options  
You can set zoom options that are available from the View tab.

1. Click Zoom on the View tab.
The Zoom Options window opens.

2. To specify a desired zoom level, select an option in the Zoom To section.
a. To adjust the zoom level to show all components, select Fit to Screen.
b. To show the entire canvas, select Extents.

3. Enter a zoom percentage in the Percent eld. Click the up or down arrow to increase or decrease the value.

Tip:  You can also change the magnication of the canvas using the zoom slider located in the boom
right corner of the Service Console.

4. Click OK.

Desktop Workows Contextual Tabs  
The contextual and standard groups and buons that display on the ribbon of the workow editor depend on the
selected tab.

When you select an element or connector on the canvas, the ribbon displays a fourth contextual tab. When an element
is selected, the Element Tools tab appears. This tab is divided into two sections. On the left are contextual groups and
buons, meaning they change depending on the element selected. On the right are standard groups and buons,
meaning they display no maer what element is selected.

This image displays the Element Tools tab and shows the contextual group of buons for the Workspace element on the
left and the standard group of buons on the right.
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Legend for image: 1. Contextual group of buons 2. Standard group of buons

Related Topics
• Desktop Workows Element Tools Tab

• Desktop Workows Path Tools Tab

Desktop Workows Element Tools Tab  
The Element Tools tab is a contextual tab that displays on the ribbon when you select an element.

Group/Buon Description

Label The buons in this group let you change the font style, size, and color of the element labels. You can
select font aributes, such as bold and italic, and change the text alignment.

 (Label Position) Click this buon to select the position of the label relative to the element. The default label position of a
new element is Inside.

Click this buon to enter the text of the element label.

Notes Click this buon to enter notes about the element.

Size The buons in this group let you to change the height and width of the element.

Related Topics
• Element Aributes

Desktop Workows Path Tools Tab  
The Path Tools tab is a contextual tab that displays on the ribbon when you select a connector.

The buons on the Path Tools tab let you format the connector and change the connector type. See Connect an
Element.

Group/Buon Description

Style The buons in this group let you change the line style of the selected connector. Available styles
include straight, square, rounded square, and curved. Rounded square is the default connector style.
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Group/Buon Description

Label The buons in this group let you change the font style, size, and color of the connector label. You can
select font aributes, such as bold and italic, and change the text alignment.

 (Label Position) Click this buon to select the position of the label relative to the element. The default label position of a
new element is Inside.

Click this buon to enter the text of the element label.

Options The buon in this group lets you enable or disable forced validation for preceding script or workspace
elements.

Causes Validation Click this buon to force a preceding script or workspace to be validated before the path is followed.

Events The buons in this group let you add and delete events that cause the path to be followed. See Add a
Connector Event.
At least one event must be dened when connecting from a workspace, script, or workow element.
 

Add Events Click this buon to add events to the connector.

Events List This list displays events that have been added to the connector.

Delete Event Click this buon to delete an event selected in the list.

Conditions The buons in this group let you add and delete conditions associated with the connector.

Add Conditions Click this buon to add conditions to the connector. See Add a Connector Condition.

Conditions List This list displays conditions that have been added to the connector.

Delete Condition Click this buon to delete a condition selected in the list.

Create a Desktop Workow  
Oracle Service Cloud provides an intuitive graphical interface for creating and editing desktop workows. When
designing a workow, you can drag elements from the Home or Insert tab and order them on the canvas.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces/Workows. The Workspaces/Workows

explorer opens on the content pane.

Note:  If the Desktop Workow feature is not enabled on your site, you will see only Workspaces listed
in the Application Appearance folder. To enable desktop workows, contact your Oracle account
manager.

3. Click New Workow on the ribbon to open a new desktop workow with a blank design canvas.
4. To design the ow diagram, see How You Design a Flow Diagram.
5. Click Save on the Quick Access toolbar to save the desktop workow. The Save As window opens.

Note:  Before saving, Oracle Service Cloud automatically validates your ow diagram and reports any
errors. Click Cancel to correct errors before saving or click Continue to save the ow in its current
state. However, the workow will not function properly until all validation errors are corrected.

6. Select the folder you want to save the desktop workow in and enter the name of the desktop workow in the
Name eld.
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7. Click Save.

How You Design a Flow Diagram  
A desktop workow is dened by dragging elements to the canvas, ordering them, and connecting them to form a ow
diagram.

The ow diagram is a graphical representation of the actions and decisions your workow will perform and the order in
which it will perform them. Your ow diagram can be as simple as a single path connecting a few workspaces or it can
be complex, routing your sta members through dozens of workspaces, scripts, actions, and decisions. The intuitive
graphical interface accommodates most business processes, extending access to advanced features and functions
found throughout the application.

When an element is selected on the canvas, an Element Tools ribbon tab appears, allowing you to dene its aributes,
which vary by element type. For example, Workspace elements are used in workows to display records using a
designated workspace. Therefore, when adding a Workspace element, you must specify the workspace you want to use
and the record you want to display.

When a record is opened in a sta member’s workow session, it is loaded into a memory space called the record pool,
along with all of its associated records (such as contact and organization). As additional records are opened in the same
workow session, those records are added to the same record pool. Because many records are often open in the record
pool at once, the term “working record” is used to describe the record being acted on by a specic element.

Each element on the canvas displays an icon and two labels that help to identify its function. The top label contains the
element name. The boom label identies the element working record. The icon varies by element type as well as the
record type.

When an element is selected on the canvas, you can select a working record from the Working Record buon group
on the Element Tools tab. If multiple records of the same record type are open in the record pool, the Working Record
buon group will expand with additional buons so you can select the specic record you want the element to act on.
For example, if several incidents are open in the record pool, you can set a Workspace element to display the incident
that was opened to initiate the workow (the initial record), the most recent incident opened in the workow (the last
record), or an incident that has been named elsewhere in the workow (a named record).

For a menu of available working records, select an element on the workspace, click the Element Tools tab, and then
click the Expand Working Records buon below the scroll bar in the Working Record buon group.

Note:  If a workow is unable to locate an open record that matches the designated working record, Oracle
Service Cloud will display a workow execution error and end the workow session.

Create a Flow Diagram  
The function of the working record varies by element type.

1. From the open workow, drag and drop an element from the ribbon onto the canvas.
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Element/Menu Description

Workspace
 

Drag and drop this element to open the working record in a workspace. See Edit
Workspace Aributes.
 

Script
 

Drag and drop this element to initiate a script. See Edit Script Aributes.
 
Script elements are only available when scripting is enabled. For information about
enabling scripts, contact your Oracle account manager.
 

Decision
 

Drag and drop this element to branch the workow based on conditions that you
dene. The working record denes the record and elds available for conditions. See to
Decision Aributes.
 

Workow
 

Drag and drop this element to nest another workow into the open workow. The
working record denes the record that opens in the embedded workow. See Edit
Workow Aributes.
 

Set Fields
 

Drag and drop this element to set values for one or more elds in the working record.
See Best Practices for Editing Set Fields Aributes.
 

Comment
 

Drag and drop this element to add comments or notes to the workow. See Add a
Comment to a Workow.
 

Connector
 

Drag and drop this element to add a connector to the workow. See Connect an
Element.
 

Create
 

Click this drop-down menu and drag and drop a record type to create a new record
in your workow. You can choose to create an answer, contact, incident, opportunity,
organization, quote, quote product, or task. See Edit Create Aributes.
 

Load
 

Click this drop-down menu and drag and drop a record type to load a record into your
workow based on a report query. You can choose to load an answer, contact, incident,
opportunity, organization, quote, quote product, or task. See Load Aributes.
 

Clear
 

Click this drop-down menu and drag and drop a record type to clear the association
between the working record and an organization, contact, answer, incident, or
opportunity. See Edit Clear Aributes.
 

Change
 

Click this drop-down menu and drag and drop a record type to associate the working
record to a dierent organization, contact, answer, incident, or opportunity. See Edit
Change Aributes.
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Element/Menu Description

 

Copy
 

Drag and drop this element to copy the working record and give it a name that can be
referenced later in the workow. See Edit Copy Aributes.
 

Save
 

Drag and drop this element to save all records open in the workow. To close the records
after saving, click Close After Save on the ribbon. See Save Aributes.
 
Business rules will be run on all open records at the time the Save element is triggered.
 

Return
 

Drag and drop this element to return to a parent workow from a nested workow.
Edit the element label text to dene a return event name that can be referenced in the
subsequent connector in the parent workow. See Return Aributes.
 

Note:  A quote product created and saved by automation elements cannot be edited afterward in
the same workow. If need arises, the Save element should be moved to occur after the edit in the
sequence, or the Save element should be omied and sta should be directed to click Save instead.

2. To connect one element to another, click an anchor on the rst element and drag the connector to an anchor on
the second element.
The anchor is highlighted when the connector is able to link to it. The connector arrow will point from the rst
element to the second. See Connect an Element.

3. To change the formaing of an element, select the element and see the associated actions.

Group/Buon Description

Label
 

The buons in this group let you change the font style, size, and color of the element
labels. You can select font aributes, such as bold and italic, and change the text
alignment.
 

 (Label Position)
 

Click this buon to select the position of the label relative to the element. The default
label position of a new element is Inside.
 

 

Click this buon to enter the text of the element label.
 

Notes
 

Click this buon to enter notes about the element.
 

Size
 

The buons in this group let you change the height and width of the element.
 

4. To cut, copy, or paste one or more elements, click the appropriate buon on the Clipboard group of the Home
tab.

5. To undo an action on the canvas, click Undo on the Quick Access toolbar.
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6. To redo an action on the canvas, click Redo on the Quick Access toolbar.

Element Aributes  
After you have added an element to the canvas, you must edit its aributes to make it functional. You can hover over
any element on the canvas to see its type, name, and other information.

Note:  You must dene aributes for each element added or a validation error will occur when aempting to
save the workow. See Workow Validation.

Elements vary by shape according to their functions.

• User Interface—Rectangular elements used to denote items that display to sta members, such as workspaces,
scripts, and other embedded workows.

• Automation—Circular elements used to denote automated events that run in the background, such as seing
eld values and creating and saving records.

• Search—Polygonal elements that require sta members to perform a search, such as loading a record or
associating a record with another record.

• Decision—Diamond-shaped and polygonal elements that denote logical evaluations that are used to branch the
ow across two or more paths based on conditions that you dene.

Edit Workspace Aributes  
This topic describes how to edit workspace element aributes.

The Workspace element is used to display the working record in a workspace. After you add this element to your ow
diagram, you must edit its aributes to associate it with a new or existing workspace. You must also select the working
record that the workspace will display.

Note:  Multi-edit and chat workspaces cannot be associated to a Workspaces element.

1. From your open workow, select a Workspace element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click a buon in the Workspace buon group.
The name label is updated with the name of the selected workspace.

Buon Description

Select Workspace
 

Click this drop-down menu to select a workspace to use in the workow.
 

New Workspace
 

Click this buon to select a new workspace type or import a workspace denition. For
information about creating a new workspace, see Edit a Workspace. For information
about importing a workspace, see Import a Workow.
 

Edit Workspace
 

Click this buon to edit the selected workspace. See Edit a Workspace.
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Buon Description

Options
 

Click this drop-down menu to access workspace aribute options.
 

Enable Save
 

Select this option to include the Save buon group when displaying a record with the
workspace. To hide the Save buon group, clear this option. This buon is enabled by
default.
 

3. Click a buon in the Working Record buon group to select the record you want to display using the workspace.
The working record label is updated with the name of the selected working record.

4. If more than one record of the selected type is open in the record pool, click a buon on the right of the
Working Record buon group to select the record you want to display using the workspace.

Tip:  For a menu of available records, click Expand Working Records below the scroll bar in the
Working Record buon group.

Edit Script Aributes  
The Script element is used to open the working record in a script. After you add this element to your ow diagram, you
must edit its aributes to associate it with a new or existing script. You must also select the working record that will be
passed to the script.

When a script is included in a workow, be sure it includes a eld, an exit script event, a nish script event, or a rule
containing a named event so that the ow can be advanced. Field changes, exit script events, and nish script events
can be used to advance the ow, as can a script rule that res a named event. See How Events are Used in Workspace
and Script Rules.

1. From your open workow, select a Script element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click a buon in the Script buon group.
The name label is updated with the name of the selected script.

3. Select a script aribute.

Buon Description

Select Script
 

Click this drop-down menu to select a script to use in the workow.
 

New Script
 

Click this buon to select a new script type or import a script denition. For information
about creating a new script, see Create a Script. For information about importing a
script, see Export a Script.
 

Edit Script
 

Click this buon to edit the selected script. See Edit a Script.
 

Options
 

Click this drop-down menu to access workspace aribute options.
 

Enable Save
 

Select this option to include the Save buon group when displaying a record in the
script. To hide the Save buon group, clear this option. This buon is enabled by default.
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Buon Description

 

4. Click a buon in the Working Record buon group to select the record you want to pass to the script. The
working record label is updated with the name of the selected working record.

Because quotes and quote products have no corresponding script type, they are not available as working
records for Script elements.

5. If more than one record of the selected type is open in the record pool, click a buon on the right of the
Working Record buon group to select the record you want to pass to the script.

Tip:  For a menu of available records, click Expand Working Records below the scroll bar in the
Working Record buon group.

Decision Aributes  
The Decision element is used to branch your workow based on conditions that you dene. After you add this element
to your ow diagram, you can edit its aributes to branch your ow to dierent paths based on whether certain
conditions are met.

The decision can be based on a simple “yes/no” evaluation of one or more conditions, such as the identity and prole of
the logged-in account, the working record creation state, and the value of a specied eld. If all conditions are met, the
Yes path is followed. If any conditions are not met, the No path is followed.

Alternately, you can base a decision on a single eld that has multiple possible values, with each selected value having
its own outgoing path. For example, by basing a decision on the incident Status eld, you can route incidents down
dierent paths based on their status.

Note:  The elds available for evaluation in a condition will vary based on the working record type selected for
the decision.

Dene Decision Aributes  
The following procedure describes the process for dening Decision aributes on a workow.

1. From your open workow, select a Decision element on the canvas.
2. From the Working Record buon group on the Element Tools tab, select a working record to associate to the

decision.
The working record label is updated with the name of the selected working record.

3. If more than one record of the selected type is open in the record pool, click a buon on the right of the
Working Record buon group to select the record you want to associate to the decision.

Tip:  For a menu of available records, click Expand Working Records below the scroll bar in the
Working Record buon group.

4. Do one of the following:
◦ Click Edit. The Decision window opens.

◦ Double-click the Decision element.

5. To dene conditions for a yes/no decision, see Dene Conditions for a Yes/No Decision.
6. To dene conditions based on a eld with multiple possible values, see Dene Conditions Based on a Field with

Multiple Possible Values.
7. Click OK.
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Dene Conditions for a Yes/No Decision  
The following procedure describes the process and options available for dening conditions for a Yes/No decision.

1. On the Decision window, click Add next to the condition you want to add to the decision description.

Condition Description

The logged in account has a certain
value
 

Add this condition to verify the identity of the logged-in account.
 

The logged in account’s prole has a
certain value
 

Add this condition to verify the prole of the logged-in account.
 

A new record is being created
 

Add this condition to verify that the working record is being created.
 

An existing record is being edited
 

Add this condition to verify that the existing record is being edited.
 

The current editor is a child editor
 

Add this condition to verify that the working record is displayed in a child editor.
 

The current editor is a primary
editor
 

Add this condition to verify that the working record is displayed in a parent editor.
 

The record is copied
 

Add this condition to verify that the working record is being copied from another record.
 

The record is not copied
 

Add this condition to verify that the working record is not being copied from another
record.
 

A eld has a certain value
 

Add this condition to verify the value of a certain eld.
 

2. If the condition you have added to the decision description contains an underlined link, click the link to edit the
condition. The Edit Condition window opens.

3. If specifying a condition value for a eld, click the Field drop-down menu and select a eld.
4. Click the Operator drop-down menu and select an operator.
5. Enter a value in the Value eld.
6. Click OK.
7. To edit the logical expression used to evaluate two or more conditions, click Combine the Conditions Using a

Logical Expression and see Edit a Workspace Rule Logical Expression.
8. Click OK.

Dene Conditions Based on a Field with Multiple Possible Values  
The following procedure describes the process for dening conditions based on a eld with multiple possible values.

1. On the Decision window, select the Decision on a Field with Multiple Possible Values option.
2. Click the Field drop-down menu and select a eld to evaluate.
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3. To verify a value in a menu eld, select the check box next to the value you want to use in the decision.
4. To remove a menu eld value from the decision, clear its check box.
5. To verify a value in a date eld, click Add Choice and then click the calendar buon in the Choice column to

select a date.
6. To verify a value in a text eld, click Add Choice and enter the value in the Choice column.
7. To remove a date or text value you have added, click Remove in the Action column.
8. To include an option for all other values, select the Include a Value for Other check box.
9. Click OK.

An outgoing anchor is added to the element for each value selected.

Edit Workow Aributes  
The Workow element is used to open the working record in an embedded workow.

After you add the Workow element to your ow diagram, you must edit its aributes to associate it with a new or
existing workow. You must also select the working record that will be opened in the embedded workow.

Note:  If you want an embedded workow to return to the primary ow, it must contain at least one Return
element. See Return Aributes.

1. From your open workow, select a Workow element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click a buon in the Workow buon group.

The name label is updated with the name of the selected workow.

Buon Description

Select Workow
 

Click this drop-down menu to select a workow to embed in the current workow.
 

New Workow
 

Click this buon to create a new workow.
 

Edit Workow
 

Click this buon to edit the selected workow.
 

3. Click a buon in the Working Record buon group to select the record you want to open in the workow.
The working record label is updated with the name of the selected working record.

4. If more than one record of the selected type is open in the record pool, click a buon on the right of the
Working Record buon group to select the record you want to open in the workow.

Tip:  For a menu of available records, click Expand Working Records below the scroll bar in the
Working Record buon group.
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Best Practices for Editing Set Fields Aributes  
This topic describes best practices for avoiding eld conicts when editing set eld aributes.

The Set Fields element is used to set values for one or more elds in the working record. After you add the Set Fields
element to your ow diagram, you must edit its aributes to select the working record containing the eld you want to
update and the value you want to set it to.

When seing multiple eld values, pay close aention to the order in which you are seing them. Remember that some
elds in the record you are updating may also change dynamically due to rule conguration or a functional dependency
on other elds.

This consideration is particularly important when updating certain key elds in Opportunity Tracking. The following
elds should be set in this specic order based on how the values are related to one another.

1. Schedule
2. Quote Total
3. Grand Total
4. Discount
5. Forecast

For example, quote totals often vary based on the schedule that has been selected. If you change the value of the
Schedule eld, the Quote Total eld value will be reset. So, if you are seing values for these two elds, be sure to apply
the schedule before seing the quote total. Also, the discount value and the forecast should be specied after the grand
total has been set. By seing these elds in the correct order, you can avoid seing elds incorrectly due to overriding
functional dependency.

Edit Set Fields Aributes  
The following procedure describes how to edit Set Field aributes from a workow.

1. From your open workow, select a Set Fields element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click a buon in the Working Record buon group to select the record containing the eld you want to set.
The working record label is updated with the name of the selected working record.

3. If more than one record of the selected type is open in the record pool, click a buon on the right of the
Working Record buon group to select the record containing the eld you want to set.

Tip:  For a menu of available records, click Expand Working Records below the scroll bar in the
Working Record buon group.

4. Do one of the following:
◦ Click Edit. The Set Fields window opens.

◦ Double-click the Set Fields element.

5. Click Add Field to add a eld to the element.
6. In the Fields column, click the Select a Field drop-down menu, expand the appropriate table, and select the

eld you want to set.
7. In the Value column, enter the value that you want to set the eld to.

Note:  In addition to seing explicit (absolute) values, you can set relative values for some eld types
by adding or subtracting (or appending or prepending) a value to the previous eld value. See Relative
Field Values.
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8. To remove a eld you have added, click Remove in the Action column.
9. Click OK.

The eld and value you selected are displayed in the text box next to the Edit buon.
10. To display a conrmation message when the eld is set, click Conrmation Message and enter the message.
11. Click OK.

Relative Field Values  
In addition to seing absolute eld values for date, date/time, integer, text, and text area elds, you can set relative
values.

When seing a value for one of these eld types, clicking the Value drop-down menu presents additional options for
adding or subtracting (or appending or prepending) a value to the previous value of the eld. For example, you can
increment the value of an integer eld by 1 or append text to a contact text eld. For date and date/time elds, you can
also set a value relative to the time of action, such as adding one day to the current date and time.

Options for seing relative eld values vary by eld type.

Field Type Value Options

Date
 

Add or subtract a number of days or weeks to or from the previous value or the current date.
 

Date/Time
 

Add or subtract a number of minutes, hours, days, or weeks to or from the previous value or the
current date and time.
 

Integer
 

Add or subtract an integer value to or from the current value.
 

Note:  The resulting value cannot be greater than the maximum value dened for the eld
or less than the minimum. Therefore, the maximum value you can add or subtract is the
maximum value minus the minimum value of the eld. For example, if the eld maximum is
8 and the eld minimum is -8, the maximum value you can add or subtract from the current
value is 16.

Text Field
 

Prepend or append a text value to the current text value.
 

Text Area
 

Prepend or append a text value to the current text value.
 

Edit Create Aributes  
The Create element is used to create a new record in the workow. After you add this element to your ow diagram, you
can edit its aributes to specify the eld values, a conrmation message, and a name for the record you are creating.

Workows that contain Create elements can create records even when used by sta members who do not have
permission in their prole to create records of the same type. For example, a sta member who does not have
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permission to create an incident can still be associated with a workow that results in the creation of an incident, and
the incident audit log will show the sta member as the creator of the incident.

1. From your open workow, click a Create element on the canvas.
The Element Tools tab displays on the ribbon.

2. Do one of the following:

◦ Click Set Fields. The Set Fields window opens.

◦ Double-click the Set Fields element.

3. Click Add Field to add a eld to the element.
4. In the Fields column, click the Select a Field drop-down menu and select the eld you want to set.
5. In the Value column, enter the value that you want to set the eld to.

In addition to seing explicit (absolute) values, you can set relative values for some eld types by adding or
subtracting (or appending or prepending) a value to the previous eld value. See Relative Field Values.

6. To remove a eld you have added, click Remove in the Action column.
7. Click OK. The eld and value you selected display in the text box next to the Set Fields buon.
8. To display a conrmation message when the eld is set, click Conrmation Message and enter the message.

a. Click OK.
9. To name the record, click New Record Name and enter the name in the working record label. The new record

name appears in the Working Record buon group for elements of the same record type.

Note:  When a new record is created with the Create element, it is not yet saved to the database. To
ensure the record is saved, be sure to open the working record in a workspace that has the Save buon
enabled or follow the Create element with a Save element. See Save Aributes.

Load Aributes  
The Load element is used to nd and load an existing record into the record pool. After you add this element to your
ow diagram, you can use it to prompt the agent to search for a record, or you can select a specic record to load every
time.

Note:  The option to load a specic record is not available when loading quotes or quote products.

If you want to prompt agents to perform a search, you must select the primary search report that will be used to nd the
record to be loaded. You may also select an optional secondary search report. The Load element can have two outgoing
connectors to branch the ow based on the buon clicked by sta on the Search window (OK/Select or Cancel). In most
cases, the Load element will prompt sta members to search for a record using a primary and secondary search report.

However, when using the Load element to open a quote, quote product, or task, the Secondary Search Report buon is
replaced on the ribbon with a Parent Record buon group. When you select a parent record for these record types, the
Load element will prompt sta members to select from a list of records associated to the parent. For example, to load a
quote, sta members select from a list of quotes associated with the specied parent opportunity.

Records opened with the Load element are simply loaded into memory and are not automatically displayed in
workspaces. To display a loaded record to your sta members, you will need to follow the Load element with a
workspace or workow associated with the appropriate working record.
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Prompt Agents to Search for a Record to Load  
Use this procedure to add search reports for the Load element.

1. From your open workow, click a Load element on the canvas. The Element Tools tab displays on the ribbon.
2. Click Search Report. The Select Report window opens.

By default, the standard report for searching the designated record type is selected. For example, if you are
loading an incident, the Incident Search report is selected by default.

3. Select a primary report to display in the Search window.
4. Click OK.
5. To select a secondary search report to display in the Search window, click Secondary Search Report. The

Select Report window opens.
a. Select a secondary report.
b. Click OK.
c. Select a secondary search record from the Secondary Search Record buon group.

6. To load a quote, quote product, or task, click a buon in the Parent Record buon group to select the parent of
the record you want to load.

7. To name the record, click New Record Name and enter the name in the working record label.
The new record name appears in the Working Record buon group for elements of the same record type.

Load a Specic Record  
Use this procedure to add a specic record to the Load element.

1. From your open workow, click a Load element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click Load Type and select Constant Record.
The Load element changes to a circular automation element and the ribbon buons refresh to display the
aributes for this load type.

3. Click Record.
4. Search for and select the record you want the element to load.
5. Click Select.
6. Click OK.
7. To rename the record, click New Record Name and enter the new name in the working record label.

The new record name appears in the Working Record buon group for elements of the same record type.

Edit Clear Aributes  
The Clear element is used to clear the association of the working record with any organization, contact, answer, incident,
or opportunity. After you add a Clear element to your ow diagram, you must edit its aributes to select the working
record you want to disassociate.

You can also clear a record association by using a Set Fields element to set the value to No Value, but using the Clear
element can make the ow diagram easier to understand.

1. From your open workow, click a Clear element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click a buon in the Working Record buon group to select the record you want to clear the association from.
The working record label is updated with the name of the selected working record.

3. If more than one record of the selected type is open in the record pool, click a buon on the right of the
Working Record buon group to select the record you want to clear the association from.
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For a menu of available records, click Expand Working Records below the scroll bar in the Working Record
buon group.

4. To display a conrmation message when the record association is cleared, click Conrmation Message and
enter the message.

5. Click OK.

Note:  When an association is cleared by a Clear element, the update is not automatically saved in
the database. To save the change made by the Clear element, be sure to open the working record in a
workspace that has the Save buon enabled or follow the Clear element with a Save element. See Save
Aributes.

Edit Change Aributes  
The Change element is used to nd and load an existing record to associate with the working record.

After you add the Change element to your ow diagram, you must edit its aributes to select the primary and
secondary search reports that will be used to nd the record to be associated. The Load element can have two outgoing
connectors to branch the ow based on the buon clicked by sta on the Search window (OK or Cancel).
When using a Change element to change the contact associated with an incident, the behavior is the same as when you
click Search on the Contact eld in an incident workspace. If the new primary contact is not already associated to the
incident (as a secondary contact, for example), the previous primary contact becomes disassociated from the incident.
If the new primary contact is already associated to the incident as a secondary contact, the previous primary contact
becomes a secondary contact. The same behavior applies to contacts associated with opportunities.

1. From your open workow, click a Change element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click Search Report. The Select Report window opens.
By default, the standard report for searching the designated record type is selected. For example, if you are
associating an incident, the Incident Search report is selected by default.

3. Select a primary report to display in the Search window.
4. Click OK.
5. To select a secondary search report to display in the Search window, click the Secondary Search Report. The

Select Report window opens where you can select a secondary report.
a. To select no secondary search report, select the No Value check box.
b. Click OK.

Note:  When you associate records with the Change element, neither record is automatically saved
or displayed to sta members. To save the change made by the Change element, be sure to open the
working record in a workspace that has the Save buon enabled or follow the Change element with a
Save element. See Save Aributes.

To display the working record or associated record to sta members, you will also need to follow the Change element
with a workspace or workow of the same record type and specify the record you want to display.
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Edit Copy Aributes  
The Copy element is used to create a new record in the workow. After you add this element to your ow diagram, you
can edit its aributes to specify the eld values, a conrmation message, and a name for the record you are creating.

When a new record is created with the Copy element, it is not automatically saved to the database or displayed to sta
members. To ensure the new record is saved, be sure to open the working record in a workspace that has the Save
buon enabled or follow the Copy element with a Save element. See Save Aributes.

To display the copied record to sta members, you will need to follow the Copy element with a workspace or workow of
the same record type and specify the copy as the working record you want to display.

1. From your open workow, click a Copy element on the canvas.
The Element Tools tab displays on the ribbon.

2. Click a buon on the left of the Working Record buon group to select the type of record you want to copy.
The last record of that type is selected by default and the working record label is updated with the name of the
selected working record.

3. To select a dierent record of the selected type, click a buon on the right of the Working Record buon group
to select the record you want to copy.

Tip:  For a menu of available records, click Expand Working Records below the scroll bar in the
Working Record buon group.

4. To select the parts of the original record to include in the record copy, click the Copy Details drop-down menu
and select the parts you want to copy. Available options vary by record type.

Record Type Copyable Details

Incident
 

Threads, incident contacts, and le aachments.
 

Contact
 

Contact lists, le aachments, and notes.
 

Answer
 

Sibling relationships, le aachments, and notes.
 

Opportunity
 

Opportunity contacts, opportunity competitors, quotes, quote products, le
aachments, and notes.
 

Organization
 

Organization addresses, le aachments, and notes.
 

Task
 

File aachments and notes.
 

Quotes and quote products can be copied but have no copy detail options.

5. To display a conrmation message when the record is copied, click Conrmation Message and enter the
message.
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a. Click OK.
6. To name the copied record, click New Record Name and enter the name in the new record label.

The new record name appears in the Working Record buon group for elements of the same record type.

Save Aributes  
The Save element is used to save all records that are open in the record pool. To close the records after saving, click to
highlight the Close After Save buon on the ribbon.

After you add a Save element to your ow diagram, you can edit its aributes to change its appearance.

Note:  When the record pool is saved with a Save element, each record update triggers business rules
immediately in the background. Because business rules introduce another layer of complexity, it is important
to use the Save element only when necessary and to keep your business rule processes separate and distinct
from your desktop workows.

Return Aributes  
The Return element is used to return an embedded workow to the primary workow to resume the ow of action.

After you add a Return element to your ow diagram, you can change its label name to dene an event name that can
be used in the primary workow. By ending dierent branches of an embedded workow with Return elements having
unique names, you can advance the primary ow in dierent directions based on the route that was followed. If you
create multiple Return elements with the same label name, any one of them will re that named event.

Note:  A Return element added to a workow that is not embedded in another workow will have no eect.

Related Topics
• Edit Workow Aributes

How You Connect an Element  
Connectors are used to link elements and indicate ow direction. Some connectors are followed immediately upon
performing an action in the originating element. Others are triggered only by events and conditions that you dene.
Connectors leading from Decision elements are followed only if the conditions are met.

To connect one element to another, click an anchor on the rst element and drag the connector to an anchor on the
second element. The anchor is highlighted when the connector is able to link to it. The connector arrow will point from
the rst element to the second.

Other ways to connect elements include:

• Hover over the rst element and click a blue arrow to link to an adjoining element.
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• Drag one element over another, hover over its blue arrow until it turns dark blue, and then drop to automatically
connect the elements.

• Click an element from the ribbon, and then hover over an element on the canvas and click its blue arrow to drop
and auto-link the new element.

• Drag and drop a connector from the ribbon to the canvas, and then drag the ends of the connector to the
elements you want to link.

Tip:  You can easily connect to a dierent element or delete a connector. From your open workow, do one of
the following:

• Click a midpoint on the connector to select it and drag one of its ends to an anchor on a dierent
element to create a dierent connection.

• Click a midpoint on the connector to select it and press Delete.

How You Edit a Square or Curved Connector  
From your open workow, click a midpoint on a square or curved connector to select it and drag the calibration points to
adjust the shape of the connection.

These images show the calibration points on square and curved connectors.

Add a Connector Event  
You must add connectors to connect one element to another in a workow.

When a record or script is displayed to a sta member, it must remain open long enough for your sta members
to complete their work before advancing to the next element in the workow. Therefore, when connecting from a
Workspace, Script, or Workow element, you must dene one or more triggering events (such as a eld value change)
that will cause the path to be followed. You can also specify conditions under which the event will cause the path to be
followed.

Note:  If a connector is triggered by an event in a workspace rule or script rule, the ow will advance without
running any subsequent rules in that workspace or script.
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1. From your open workow, click the connector on the canvas.
The Path Tools tab displays on the ribbon.

2. Click Add Events.
The Select Connector Events window opens.

3. Click Add next to the event you want to add to the connector.

Available events vary based on the type of element you are connecting from.

Event Description

The editor loads
 

Add this event to follow the path when a record is loaded using the workspace.
 
When using this event, the connector conditions are evaluated at the time a record
is opened. If any of the conditions require that items be changed after the record is
opened, the path will not be followed.
 

The record is saved without closing
 

Add this event to follow the path when an open record is saved without closing.
 
This event is not triggered if records are closed when saved, or closed without being
saved. This includes records opened in child editor windows that do not feature Save
buons.
 

A eld changes
 

Add this event to follow the path when the value of a eld is changed. When added,
 click the underlined text to select a eld that will trigger the event. Available elds
vary depending on the type of workspace you are connecting from. For example,
 when connecting from an incident workspace, you can select elds from the incidents,
 contacts, and organizations tables. However, not every eld in these tables is available
for use in connector events.
 
When using this event, connector conditions are evaluated at the time any change
is made to the selected eld. If the selected eld is a text eld, the conditions will be
evaluated the moment any character in the eld is changed.
 

An input control value changes
 

Add this event to follow the path when the value of an input control is changed to
another value or to no value. When added, click the underlined text to select an input
control that will trigger the path. Available input controls include any menus, options, list
boxes, and text boxes that are not used to trigger other paths.
 
This event is available only when an input control has been added to the workspace.
When using this trigger, conditions are evaluated at the time any change is made to
the input control. If you want to verify that a specic value was selected, add An Input
Control Has a Certain Value as a condition.
 

An input control value is selected
 

Add this event to follow the path when an input control value is selected. When added,
 click the underlined text to select an input control that will trigger the path. Available
input controls include any menus, options, and list boxes that are not used to trigger
other paths.
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Event Description

This event is available only when an input control has been added to the script. When
using this trigger, conditions are evaluated at the time a value is selected from the input
control. If you want to verify that a specic value was selected, add An Input Control Has
a Certain Value as a condition.
 

A buon is clicked
 

Add this event to follow the path when a specied buon is clicked. When added, click
the underlined text to select a buon from the workspace that will trigger the event.
 

An image is clicked
 

Add this event to follow the path when an image is clicked. When added, click the
underlined text to select an image from the workspace that will trigger the event.
 
This trigger is available only when an image has been added to the workspace.
 

A hyperlink control is clicked
 

Add this event to follow the path when a hyperlink is clicked. When added, click the
underlined text to select a link from the workspace that will trigger the event.
 
This trigger is available only when a hyperlink has been added to the workspace.
 

The exit script event res
 

Add this event to follow the path when the Exit buon is clicked, an exit script event is
red by a rule from a script called in a workow, or from a script placed on a workspace
called in a workow. Connector conditions are evaluated at the time that the event is
red. See How Events are Used in Workspace and Script Rules.
 

The nish script event res
 

Add this event to follow the path when the Finish buon is clicked, a nish script event is
red by a rule from a script called in a workow, or from a script placed on a workspace
called in a workow. Connector conditions are evaluated at the time that the event is
red. See How Events are Used in Workspace and Script Rules.
 

A named event res
 

Add this event to follow the path when a specied named event res from a workspace
rule or from a rule in a script that has been placed on the workspace. Click the
underlined text to enter the name of the event that will be used to trigger the connector
event. Connector conditions are evaluated at the time that the event is red. See How
Events are Used in Workspace and Script Rules.
 
When a connector is triggered from a workspace or script rule by a named event,
 the rule will stop running and any actions that follow the event in the rule will not be
performed.
 

4. Click any underlined text in the Edit the Connector Description section to open a window where you can specify
the source of the event action (such as the eld, control, or event name).

5. To remove an event from the connector description, hover over the event and click Remove.
6. Click OK to add the event to the connector.
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Add a Connector Condition  
Workspace elements can have more than one outgoing connection, each triggered by a dierent set of events and
conditions. In this way, a single workspace can route sta members through dierent sequences of actions and
decisions based on the event that was triggered.

1. From your open workow, click the connector on the canvas.
The Path Tools tab displays on the ribbon.

2. Click Add Conditions.
The Select Connector Conditions window opens.

3. Click Add next to the conditions you want to add to the connector.

Available conditions vary based on the type of element you are connecting from.

Condition Description

The logged in account has a certain
value

Add this condition to follow the path if the logged-in account has a certain value. Click
the underlined text to select the account to be evaluated.

The logged in account’s prole has a
certain value

Add this condition to follow the path if the logged-in account’s prole has a certain
value. Click the underlined text to select the prole to be evaluated.

A new record is being created Add this condition to follow the path if a new record is being created by the originating
workspace.

An existing record is being edited Add this condition to follow the path if an existing record is being edited in the
originating workspace.

The current editor is a child editor Add this condition to follow the path if the record is open in a child editor.

The current editor is a primary
editor

Add this condition to follow the path if the record is open in a primary (non-child) editor.

The record is copied Add this condition to follow the path if the record is being copied from another record.

Tip:  This condition can be useful if you want to automatically set eld values
when records are copied.

The record is not copied Add this condition to follow the path if the record is not being copied from another
record.

A eld has a certain value Add this condition to follow the path if a eld has been set to a specied value in the
originating workspace. Click the underlined text to select the eld to be evaluated.

A eld is required Add this condition to follow the path if a eld is required in the originating workspace.
Click the underlined text to select the eld to be evaluated.

A eld is optional Add this condition to follow the path if a eld is optional (not required) in the originating
workspace. Click the underlined text to select the eld to be evaluated.
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Condition Description

A eld is read only Add this condition to follow the path if a eld is read-only in the originating workspace.
Click the underlined text to select the eld to be evaluated.

A eld is editable Add this condition to follow the path if a eld is editable in the originating workspace.
Click the underlined text to select the eld to be evaluated.

A eld is hidden Add this condition to follow the path if a eld is hidden in the originating workspace.
Click the underlined text to select the eld to be evaluated.

A eld is visible Add this condition to follow the path if a eld is visible in the originating workspace.
Click the underlined text to select the eld to be evaluated.

An object is read only Add this condition to follow the path if a control is read-only in the originating
workspace. Click the underlined text to select the control to be evaluated.

An object is editable Add this condition to follow the path if a control is editable in the originating workspace.
Click the underlined text to select the control to be evaluated.

An object is hidden Add this condition to follow the path if a control is hidden in the originating workspace.
Click the underlined text to select the control to be evaluated.

An object is visible Add this condition to follow the path if a control is visible in the originating workspace.
Click the underlined text to select the control to be evaluated.

An input control has a certain value Add this condition to follow the path if a specied question control value has been
selected in the originating script element. Click the underlined text to select the control
to be evaluated.

An add-in control condition returns
a certain value

Add this condition to follow the path based on whether an add-in control returns a
certain value. Click the underlined text to select the add-in control and the parameters
to be evaluated. See Overview of Add-Ins.

4. If a condition you have added to the description contains underlined text, click the underlined text to open the
Edit Condition window.

a. If dening a condition based on a value for a eld, click the Field drop-down menu and select a eld.
b. Click the Operator drop-down menu and select an operator.
c. Enter a value in the Value eld.
d. Click OK to close the window.

5. To remove a condition from the connector description, hover over the condition and click Remove.
6. To evaluate the conditions using a logical expression, click Combine the Events Using a Logical Expression.
7. Click OK to add the condition to the connector.

Add a Comment to a Workow  
The Elements buon group provides a Comment element that lets you add comments to your diagram without
impeding the ow of action.
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Comment elements can be connected to other elements but they do not accept incoming connections. Used to convey
information only, comments have no impact on the actions or events that comprise the workow.

1. From your open workow, drag and drop a Comment element from the ribbon onto the canvas.
2. Click the element to enter your comments.
3. To connect the Comment element to another element, click an anchor on the Comment element and drag to

the element. The element is highlighted when the connector is able to link to it.

Note:  Connectors from Comment elements are dashed lines, indicating that they do not impact the
ow of action.

Apply a Workow Template  
The Template buon group on the Insert tab of the workow designer provides several predened templates as a
starting point for creating your ow diagram.

When you choose a template, the elements and connectors associated with that template are added to your diagram.
You can add and remove elements to further customize your workow, then edit element aributes to meet your
business needs.

1. From the Template group of the Insert tab, hover over a template buon to see it previewed on the canvas.
◦ New vs. Edit—This template directs sta members to one workspace if they are creating a new incident

and to a dierent workspace if they are opening an existing incident. See New vs. Edit Workow Template.
◦ Add Task—This template displays an incident in a workspace and then automatically creates a new task

for the incident. See Add Task Workow Template.
◦ Copy Incident—This template displays an incident in a workspace, and then copies the incident, sets

elds in the copy, and displays the copy in another workspace. See Copy Incident Workow Template.
◦ Create Contact—This template checks whether an open incident is associated with a contact record. If no

contact is associated, it automatically creates a new contact for the incident and sets contact elds before
displaying the incident in a workspace. See Create Contact Workow Template.

2. Click a template buon to add the template to the canvas.
A message opens warning you that selecting a template will overwrite the existing content on the canvas.

3. Click OK.
The template is inserted in the diagram.

4. Select each element and edit its aributes. See How You Design a Flow Diagram.
5. Click Save.

New vs. Edit Workow Template  
This template uses a decision element to determine if the sta member is creating a new incident or opening an
existing incident. Based on the decision, the sta member is either directed to a workspace designed for new incident
creation or a workspace designed for editing existing incidents.

Element Description

Entry Point This element indicates the starting point of the workow.

Editor Mode Incident This Decision element checks whether the incident open in the workow is a new incident or an
existing incident. The working record is set to Incident, referring to the incident being created or
opened.

Workspace Incident
(New Path)

This Workspace element displays a new incident in a workspace. The working record is set to Incident,
 referring to the incident being created.
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Element Description

 

Workspace Incident
(Edit Path)
 

This Workspace element displays an existing incident in a workspace. The working record is set to
Incident, referring to the incident being opened.

Add Task Workow Template  
This template opens an incident in a workspace. Then, based on an event you dene in the outgoing connector, a task is
automatically added to the incident.

Element Description

Entry Point This element indicates the starting point of the workow.

Workspace Incident This Workspace element displays the opening incident in a workspace. The working record is set to
Incident, referring to the incident that is being opened in the workspace.

Task New Task This Create element automatically creates a new task associated with the incident and names the task
“New Task.”

Copy Incident Workow Template  
This template opens an incident in a workspace. Then, based on an event you dene in the outgoing connector, the
incident is copied, elds are set in the copy, and the copy is displayed in another workspace.

Element Description

Entry Point This element indicates the starting point of the workow.

Workspace Initial Incident This Workspace element displays the opening incident in a workspace. The working record is set to
Initial Incident, or the incident that is initiating the workow.

Copy Last Incident The Copy This Copy element copies the incident to a new incident and names the copy “The Copy.” The working
record is set to Last Incident so the element will copy the incident last opened in the workow.

Set Fields The Copy This Set Fields element updates incident elds. The working record is set to The Copy so the element
will update elds in the incident copy.

Workspace The Copy This Workspace element displays an incident in a workspace. The working record is set to The Copy so
the element will display the incident copy.

Create Contact Workow Template  
This template uses a Decision element to determine if the incident being opened is associated with a contact record. If
no contact is associated, it automatically creates a new contact for the incident and sets contact elds before displaying
the incident in a workspace.

Element Description

Entry Point This element indicates the starting point of the workow.
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Element Description

Has Contact? Incident This Decision element checks whether the incident being opened is associated with a contact record.
If so, the ow is forwarded to the Workspace element. If not, the ow is directed to the Create element.
The working record is set to Incident, referring to the incident being opened in the workow.

Contact New Contact This Create element automatically creates a new contact and names the contact “New Contact.”

Set Contact Incident This Set Fields element updates the incident Contact eld to the new contact, associating the two
records. The working record is set to Incident so the element will make the update to the incident
opened earlier in the workow.

Workspace Incident This Workspace element displays the opening incident in a workspace. The working record is set to
Incident so the element displays the incident opened earlier in the workow.

Workow Validation  
Because even basic workows can contain many components that must be congured correctly in order to function
properly, it is important to test your workows thoroughly before you take them to production. Oracle Service Cloud
provides features to help you validate and preview workows as you create them.

As you create a ow diagram for your workow, Oracle Service Cloud validates all ow elements to ensure all required
aributes have been specied. Although validation occurs in real time as you add and update elements, you can review
validation errors manually at any time by clicking the Validate buon on the Home tab.

You can also choose to display validation ags to help quickly identify invalid elements. When you select the Validation
Results check box on the View tab, valid elements are agged with a green check mark, while those found to be invalid
are agged with a red exclamation point and a small buon you can click to view the validation error.

If you aempt to save a workow without rst addressing its validation errors, you will receive a message summarizing
the errors.

Note:  You can save a workow without rst correcting validation errors by clicking Continue on the
Validation Results window. However, the workow will not function properly until all validation errors have
been corrected.

Preview a Workow  
In order to thoroughly test the workows you create, the Preview feature simulate the eects of the workow you are
editing, without altering your own prole seings or updating your production data.

After you select a record type and choose a new or existing record, a preview window opens to display the Service
Console as it would appear to a sta member opening the same record in the live workow. Except for saving records
(which is disabled), the full functionality of your workow is available for you to test in a read-only environment.

Note:  Because record saving is disabled, you will not be able to test “The record is saved without closing”
events in preview mode. To test subsequent elements in the ow, you must temporarily select a dierent
event.

1. From the open workow, click Preview on the Home tab.

712



Oracle Service Cloud
Using Service Cloud

Chapter 3
Dynamic Agent Desktop

The Workow Preview window opens.
2. Select the type of record you want to preview in the workow.
3. To simulate the workow using a new record, select New Record.
4. To simulate the workow using an existing record, select Open a Record and enter the record ID in the Enter ID

eld.
5. Click OK.

A preview window opens where you can test the workow.

Tip:  Elements such as Create, Clear, Copy, and Set Fields perform automated actions in the
background that advance the ow without visual indication. To verify these elements during testing,
you can use the Conrmation Message buon to add a visual indicator that an action has been
performed.

Export a Workow  
If you have a workow that you want to copy to another interface, you can export the workow and then import it on
the other interface.

Exported workows contain all included workspaces (with all elements, elds, controls, layout, and rules), decisions,
actions, and other embedded workows. Alternately, you can export the contents of your canvas as an image le for use
as a visual reference.

1. On the Workspaces/Workows explorer, right-click the workow you want to export and select Open.
The workow opens.

2. Click File and select  Export > Export Denition . The Export Workow window opens.

Note:  You can also export an image of the canvas to your workstation by selecting Export followed by
Export Image.

3. If the workow contains embedded workspaces, scripts, or nested workows, select the Export Workow
Denition Only option to export the workow denition only. By default, the workow denition is exported
along with any contained workspaces, scripts, and workows.

4. Click OK.
The Save As window opens.

5. Select the location where you want to save the workow denition le and enter the le name.
6. Click Save.

Workow denition les are saved with a hash value that is used when the le is imported to determine if the
le has been modied externally. If the le has been modied, it will not be available for importing and an error
message will notify you that the le is invalid.

Import a Workow  
You can import a workow, including any contained workspaces, scripts, and workows.

1. On the Home tab of the Workspaces/Workows explorer, click New Workow.
A new workow opens.

2. Click File and select Import Denition.
A message appears indicating that the import process will overwrite the current open workow.
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3. Click Yes to allow the import to overwrite the current open workow.
The Import Workow wizard opens.

4. Click Next.
5. Do one of the following:

◦ Enter the path and name of the workow denition le you want to import.

◦ Click Browse to nd the le on your workstation and click Open.

If the workow contains workspaces, scripts, or nested workows, you will be prompted to select whether to
include them in your import.

6. To import the workow denition along with any contained workspaces, scripts, and workows, click Next.
a. Select the folder you want to save the workspaces and workows in and click Next.
b. Click the Map To Type drop-down menu to select a record type for each workspace and script you are

importing.
c. If a contained workspace includes records from a custom object, click the Map To Record Type drop-

down menu and select the record type you want to map the records to. If Oracle Service Cloud detects a
record type of the same name already in the site, it is selected by default.

d. Click Next.
7. To import only the workow denition, select Import Workow Denition Only and click Next.
8. If the workow contains elds that do not exist in the database, they are listed in the wizard as invalid. To

remove invalid eld references from the workow, click Next.
9. Click Finish.

The desktop workow canvas opens with the imported workow.

Best Practices for Creating Desktop Workows  
Desktop workows can meet a broad range of needs, some simple and some complex. Complex workows can be
challenging to manage, but keeping your ow diagram elements grouped intuitively on your canvas can help make it
easier to understand, in case the workow needs to be revised later.

The following practices can also be helpful when creating and updating workows.

• Apply logic prudently—Desktop workows contain many points where logic may be used, such as script
elements, workspace elements, decision elements, and connectors. The best places to incorporate logic will
depend on your use case, but be sure to consider the full impact and scalability of the workow when adding
these functions. Creating logic that is simple and distinct with minimal overlap is much easier to maintain and
modify over time.

• Track and advance your ows—Record updates made by workows are tracked in record audit logs, but
sometimes tracking the path a record has taken through a complex ow can be challenging. To make this
easier, you can add a custom eld to manage the workow “state.” For example, if an agent completes a key
step in a workow, consider running a rule action to update an easily reviewed custom eld signifying that the
step was completed. With this information tracked by a eld, you could even check its value in an initial decision
point to bypass steps completed in previous edits of the record.

For more best practices for using the various features that comprise the dynamic agent desktop, see Overview of the
Dynamic Agent Desktop.
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4  Analytics

Overview of Analytics  
Oracle RightNow Analytics Cloud Service (Analytics) provides the tools you need to view and create reports that show
information about the activities and content on your Oracle Service Cloud site.

These links give you access to information about the tools used to create, manage, and share reports and dashboards.

How to Monitor Report Usage—Describes management reports you can view to monitor how and where the reports on
your site are being used. This information is intended for managers and site administrators.

Overview of the Analytics Explorers—Describes the explorers you use to create and manage reports, including the
images explorer

Overview of Creating Basic Custom Reports—Describes the procedures you need to follow to create a simple report.
This is intended as an introduction to creating and editing reports.

Overview of Managing Reports on the Reports Explorer—Describes the tools and procedures to view existing reports,
and how to modify the display of data in reports.

Overview of Dashboards—Describes how to create, edit, and view dashboards.

Overview of Custom Reports—Describes how to create custom reports, and how to edit existing reports.

View Your Database Data Dictionary—Describes the information displayed in the data dictionary. The data dictionary
gives you a view into the database where the content of your site is stored.

Overview of the Transactions Database Table—Describes the information in the Transactions table. This table stores
information about actions that users take on contacts, incidents, and other types of records on your site. This table is
frequently used in standard reports, and you can use the table in custom reports as well.

Analytics Conguration Seings—Describes the conguration seings that impact information displayed in reports.

Monitoring Report Usage  

How to Monitor Report Usage  
Several reports are available to help you determine how and where your reports and dashboards are used.

As a manager or site administrator, it is important to understand who uses the reports and dashboards on your site,
how often they are used, and where they are used. You can view this information using the Expanded Report Audit Log,
and the reports available in the Report Management module.

The Expanded Report Audit Log lists every instance of every report on your site being generated, printed, exported, and
previewed over the previous 30 days. See View the Expanded Report Audit Log.

The reports in the Report Management module give you information about scheduled reports and dashboards, reports
and dashboards that require excessive processing time, and reports and dashboards used in workspaces, report links,
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and navigation sets. You can also nd reports and dashboards that meet criteria you specify and generate a list of
descriptions for any of your public reports and dashboards.

If you need a list of the reports available on your site, you can use the View Report Descriptions report, available in the
Report Management component. With this report, you can produce a catalog of reports that displays the descriptions of
standard and custom reports. This can help you nd an existing report you can use to nd information you want, or that
you can copy to create a custom report that more precisely meets your reporting needs. See Create a List of Reports.

Note:  The reports in the Report Management component use data that is not available in the report designer,
and perform non-standard post-processing of the data. Consequently, these reports cannot be copied or
edited like the standard reports. In addition, these reports aren’t accessible with the Public API.

To access the Report Management component, you need to add it to your navigation set. See Overview of Navigation
Sets. You also must congure your prole permissions to access the management reports you want. See Congure
Management Reports Permissions.

Congure Management Reports Permissions  
Your sta members roles can access dierent management reports depending on their roles.

Sta members with the Analytics Administrator permission can run all management reports. For those sta members
without this permission, their access to management reports is determined by their other prole permissions. These
permissions and the reports that can be accessed are described here. See Proles for information about modifying
prole permissions.

• Sta members with permission to run one or more reports, but who lack permissions to edit workspaces or
navigation sets, can access the management reports in these folders.

◦ Performance

◦ Find

◦ Denition

◦ Reference

• Sta members who can run one or more reports and who have permission to edit workspaces can access the
management reports in these folders.

◦ Performance

◦ Find

◦ Denition

◦ Reference

◦ Workspaces

• Sta members who can run one or more reports and who have permission to edit navigation sets can access
the management reports in these folders.

◦ Performance

◦ Find

◦ Denition

◦ Reference

◦ Navigation Sets
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Open a Report in the Report Management Component  
You can open the Report Management component from your navigation pane.

1. Click Analytics on the navigation pane and then double-click Report Management.
Because you can add this component to any navigation buon in your navigation set, you may need to click
another navigation buon to access it.

2. Open the folder containing the report you want to run.
The folders and the types of reports they contain are described here. You can hover over report names to view
descriptions of them.

Folder Description

Schedules
 

The reports in this folder display the scheduled reports that are being sent, helping
administrators beer manage receipt of scheduled reports. Depending on the report
you select, you can search by individual email addresses, email subject lines, or report
names. See Schedule a Report.
 

Workspaces
 

The report in this folder displays the workspaces that use a particular report, helping
administrators understand the impact of changing or deleting a report. See Overview of
Workspaces.
 

Navigation Sets
 

The reports in this folder display the reports included in specied navigation sets or the
navigation sets that include the specied reports. This helps administrators determine if
a report can be deleted or modied. See Overview of Navigation Sets.
 

Performance
 

The reports in this folder help administrators nd reports that may require excessive
processing to run, including reports that have no lters and reports that are
automatically deferred due to processing time. These reports can then be modied to
reduce the processing time or restricted to those sta members who understand the
impact of running them.
 

Find
 

The reports in this folder are used to nd reports that contain certain descriptions,
 custom scripts, column headings or column descriptions, and references to particular
tables or columns in the database.
 
We recommend using the Reports by Database Reference report to nd reports that
query a particular database eld, such as when you want to delete a system aribute
and need to know which reports use the eld.
 

Denition
 

The report in this folder returns the report descriptions for the reports you specify,
 allowing you to easily create a catalog of reports that can be used to understand the
available public reports. See Create a List of Reports.
 

Reference
 

The reports in this folder show you reports that are used in dashboards or in report
links. See Overview of Dashboards and Overview of Linked Reports.
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Folder Description

 

3. Double-click the report you want to run.

Search options vary depending on the report you run. Some reports have required lters (the lter names
display in red with an asterisk), while other lters do not require you to select values for them. You can also
specify limit, paging, and sorting options, and change the layout of the search window. See Search for Records
in a Report.

The Search window opens where you can select options to lter and sort the report’s output. Any required
lters are indicated by red text. You can also use paging options to specify how many records you want to
display per page.

4. Select the lter options you want and click Search. The report output displays.

As with other reports you run, you can sort the output, print and export the report, and apply slicing and other
options. You can also run the report again, selecting dierent search criteria in the docked lters shown above
the report output.

Related Topics
• How You Distribute Reports and Dashboards

• Search for Records in a Report

• Dene Rollups

• Slice Report Data

Create a List of Reports  
With the large number of standard reports available in Oracle Service Cloud, it can be challenging to understand what
each report provides. Using the View Report Descriptions report in the Report Management component, you can
generate listings of column and report output denitions for any standard or custom reports.

While the Analytics Administrator prole permission is required to run any of the reports in Report Management, you
can export, print, or publish the output so other sta members can view the report descriptions. See How You Distribute
Reports and Dashboards.

Note:  Report output denitions are precongured for standard reports. For information about adding
descriptions to custom reports, see Display Output Descriptions.

1. Click Analytics on the navigation pane and then double-click Report Management.
Because you can add this component to any navigation buon in your navigation set, you may need to click
another navigation buon to access it.

2. Expand the Denition folder and then double-click View Report Descriptions.
The Search window opens.

3. Select the reports you want to include in the output.
By default, all reports are selected, but since this is a required lter, you need to specify the reports you’re
interested in. You can select all the reports in a top-level folder by selecting the check box next to the folder.

4. Click Search to run the report.
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The report descriptions are displayed on the content pane.
5. To see a report’s column descriptions and expressions, click the Details link in the View column.

View the Expanded Report Audit Log  
The Expanded Report Audit Log provides administrators with information about reports that have been viewed or
accessed. This information is recorded for all reports in your Service Cloud site, regardless of where they were accessed.

This report is accessed from the Reports Explorer, but uses information from a table that is not accessible for use in
custom reports. For this reason, it is not possible to copy this report.

Note:  The data displayed in the Expanded Report Audit Log accumulates quickly since it is stored every time
a report is run, previewed, forwarded, printed, or exported. To prevent the accumulation of this data from
impeding site performance, it is purged 30 days after the tracked event occurs. If you need data stored longer
than 30 days, you will need to run the audit log on a regular basis and export the data that is returned to
another location.

This procedure describes opening the Expanded Report Audit Log from the Reports Explorer. However, it can also be
added to navigation sets.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Expand  Public Reports > Common > Site Administration > Reports .
4. Double-click the Expanded Report Audit Log report.

The report’s Search window opens.
5. Select the lters you want to use to limit the amount of data returned by the report.
6. Click Search.

The results display on the content pane.

These are the elds you will see in the Expanded Report Audit Log.

• Report—This is the ID number of the report.

• Report Name—This is the name of the report.

• Account First Name—This is the rst name of the sta member who performed the report action.

• Account Last Name—This is the last name of the sta member who performed the report action.

• Type—This is the type of action that occurred. The available options are Generated, Forwarded, Exported, and
Printed.

• Start Date—This is the time the report action was initiated.

• End Date—This is the time the report action completed.

• Source Level—This is where the report action occurred. For instance, reports generated on the Reports explorer
have a source of CX Console > Console Standard Report, and reports generated through the Connect Public API
have a source of Public API > Connect PHP.

• Result Code—This is the result of the aempt to perform the action. The available options are Success, Too
Much Data, Timed Out, and Unexpected Error.

• Description—This lists the accounts and email addresses that a forwarded report was sent to.
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Analytics Explorers  

Overview of the Analytics Explorers  
The reporting features in Oracle Service Cloud are accessed through the Oracle RightNow Analytics Cloud Service
(Analytics) explorers.

Analytics explorers are accessed by clicking Analytics on the navigation pane. Your access to Analytics explorers is
determined by your navigation set and prole permissions. See Overview of Navigation Sets and Proles.

From Analytics explorers, you can create custom reports and dashboards, view standard and custom reports, and edit
report styles, chart styles, color schemes, images, and text elds to use with reports and dashboards. See Download
Oracle Service Cloud and Log In.

Search for Analytics Items  
You can search for reports, styles, images, or other types of items specic to the explorer you’re using.

For instance, you can search for reports and dashboards from the Reports Explorer and text elds from the Text Fields
Explorer.

Note:  A separate Quick Search feature is available that enables you to search for a specic le or record no
maer where you are in the product. See Overview of Quick Search.

The following procedure describes how to search for reports from the Reports explorer. However, the basic procedure is
the same for all explorers—only the columns available for searching change between explorers.

1. Click Analytics on the navigation pane and then double-click Reports Explorer.
2. Click Find. The left side of the content pane displays a menu, hiding the folders tree.

Note:  All of the Analytics explorers include a ribbon for working with items shown in the explorers.

3. Enter eld information.

Field Description

Find Using
 

Click this drop-down menu to select a column in the reports list to search on. You can
search by the report’s name, ID number, dates created or updated, the report’s initial
run (opening report without prompting for search parameters) status, or the refresh on
edit status. Each column is associated with one of three data types which determine the
available search options:

◦ Strings—Search for strings that start with, contain, end with, or match the value
you enter in the text box.

◦ Dates—Search for dates before, on, or after today’s date. You can also click the
calendar to display the current month’s calendar and select another day, or click
the arrows at the top of the calendar to change months.

◦ Integers—Search for values that are less than, equal to, or greater than a number.
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Field Description

Search text box
 

Type your search text in this eld.
 

Case Sensitive
 

When searching a string column, select this check box if you want to match the case.
 

Show Advanced Options
 

Click Show Advanced Options to display additional search options.
 

Search globally, replace results
 

Select this option to remove the results from the previous search and replace them with
results from this search.
 
This is the default option.
 

Search globally, append to results
 

Select this option to keep results from the previous search and add results to them from
this search.
 

Search within results, replace results
 

Select this option to search the current search results and keep only those results that
match the new search.
 

Return Non-matching Items
 

Select this check box to return all reports that do not match your search criteria.
 

4. Click Find.
The search results display on the right pane. A message displays if no results are found.

5. To remove the text entered for the previous search, click Clear on the Find menu.
6. To replace the search results with the original reports list, click Refresh.
7. To remove the Find menu and display the folders list, click Folders.

Related Topics
• Run a Standard Report (video)

Copy Analytics Content  
You can copy reports, styles, chart styles, and color schemes shown in the Analytics explorers, and then edit the copies
to create your own customized versions.

1. Open the appropriate explorer.
2. Right-click the item you want to copy.
3. Select Copy to open the Copy As window.
4. To store the new item in a custom folder, navigate to the folder.

Note:  Custom les cannot be stored in the Reports explorer’s or Images explorer’s standard folders.

5. Enter a name for the new item in the Name eld.
6. Click OK.
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Save an Item  
The procedure to save custom reports, report styles, chart styles, color schemes, and text elds is similar, no maer
what type of item you’re saving.

1. After editing the item, select the appropriate save option on the Home tab:

◦ To save changes to the item without closing it, select Save.

◦ To save a new item, or to save a copy of the item you’re editing with a dierent name, select Save As.

◦ To save changes to the item and close it, select Save and Close. This option is faster than saving a
change and then manually closing the window.

Note:  Options for saving a custom report are accessed by clicking the arrow on the Save buon on
the report designer’s Quick Access toolbar.

When you select Save As, or aempt to save a new item for the rst time, the Save As window opens to name
the item.

2. To store the new item in a custom folder, navigate to the folder.
You can store custom les only in custom folders.

3. Enter a name for the new item in the Name eld.
4. Click OK.

How You Create Custom Folders  
You can create custom folders in any explorer.

These can help you organize new or copied reports, styles, chart styles, color schemes, images, and text elds. You can
also rename custom folders and les.

Create a Custom Folder  
You can add folders to any parent folder that accepts custom folders.

1. Open the appropriate explorer.
2. Right-click the parent folder you want to add the custom folder to.

Note:  Not all standard folders accept custom folders.

3. Select New Folder.
4. Enter a name for the folder.
5. Click outside the folder name, or press Enter, to save the folder.

Rename a Custom Folder  
You can use the rename folder feature when saving or copying a custom folder.

1. Open the appropriate explorer.
2. Right-click the custom folder.
3. Select Rename.
4. Enter a new name for the folder.
5. Click outside the folder name, or press Enter.

Tip:  You can also use right-click functionality to rename custom folders when you’re saving or
copying items.
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Reports Explorer  
The Reports explorer provides you with one location to view and organize reports, and edit and create custom reports
and dashboards.

The content created in the other Analytics explorers is applied to reports using the Reports explorer.

Reports are contained in folders in the Reports explorer. These folders are in a tree structure and can be expanded or
collapsed to hide or display their contents. Reports that are accessible by multiple sta members are contained in the
Public Reports folder, and private reports that are accessible only to the sta member who created them are stored in
the My Reports folder.

Note:  Other sta members’ My Reports folders are not displayed in the Reports explorer. However,
administrators can log in with the administrator account to access every account’s folders. This ensures that
private reports can be edited, moved, and deleted if necessary.

Clicking a folder in the Reports explorer’s tree displays the folder’s contents in the list on the right. A folder’s
contents can include reports, dashboards, and subfolders. Reports and dashboards contained in the same folder are
automatically sorted in alphabetical order and cannot be reordered. However, you can drag items from one folder to
another.

Right-clicking a folder or report displays a list of actions you can take on the item, such as opening a report for editing
or queuing a report.

Related Topics
• Overview of Managing Reports on the Reports Explorer

• Overview of Custom Reports

• Overview of Dashboards

Styles Explorer  
Report styles let you quickly apply custom display seings to your reports without editing the underlying report.

Styles can also help sta members use the same display seings for their reports so that all reports generated by your
sta share the same appearance. For information about applying a style to a report, see Apply a Style to a Report.

A number of default styles are available, which may be all you need. However, you can easily create and edit styles to
dene the specic fonts, colors, borders, and margins which are most appropriate for your target audience. You can
then apply your custom styles to reports just as you would the default styles.

Tip:  When conguring reports to display on the Browser User Interface, you can use any style you want, but
we suggest trying the Web Theme style, which is congured for optimal display on web browsers.

You can edit style options for various components used in reports, such as text elds, column headers, exceptions
descriptions, or entire report sections. You can also associate a custom chart style with your report style that will be
applied to charts added to reports.
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The style options vary depending on the type of component you’re editing. For example, the options for a text
component include a Font tab, whereas the options for a non-text component do not, since font seings do not apply.
See Overview of Report Sections for descriptions of the various components that can be added to reports.

Create a Style  
The Style editor displays examples of the various report components that you can create custom styles for. This helps
you identify the component you want to modify. You can also select the component you want to modify from a list if
you know its name.

1. Click Analytics on the navigation pane.
2. Double-click Styles Explorer.

The Styles explorer opens, displaying the current styles.
3. Do one of the following:

◦ To create a style, click New.

◦ To edit an existing custom style, right-click the style and select Edit.

The Style editor opens.
4. Do one of the following:

◦ Select the component whose style you want to modify from the drop-down menu at the top of the editor
and click Edit.

◦ Double-click the component on the Style editor.

A window opens for selecting style options.
5. Select the style options you want for the selected component. See Specify Style Options.
6. To associate a custom chart style with the report style, click the name of the chart style that is currently

associated with the report style, shown next to Aached Chart Style. The Select Chart Style window opens.
7. Select the chart style you want to associate with the report style.
8. Click OK.

Note:  The associated chart style is used by default for charts added to reports that use the report
style. However, dierent chart styles can be selected when creating charts. See Chart Styles Explorer
for information about chart style options. For information about adding charts to reports, see How to
Add and Edit Charts.

9. Click Save.

Specify Style Options  
After selecting the component you want to modify from the style editor, you can dene options for the component’s
font, margins, background colors, and borders.

You can access all the style options for the selected component from the window that displays when you select a
component and click Edit. However, you can also select common style options for the selected component using the
buons on the explorer’s ribbon, which provide shortcuts to many of the same options available on the window. In this
procedure, we show you how to change options from the window.

1. Open the Style editor window for the component you have selected.
By default, the window opens on the Font tab if the selected component includes text. See Change Font
Aributes from the Font Tab for information about this tab.

2. Click the Margins tab to dene the amount of space surrounding the component when used in reports.
3. Enter the number of pixels between the text and the left, right, top, and boom margins.
4. If you’re editing a style for a report section, such as the report header, enter the number of pixels you want

between the section’s contents in the Spacing eld.
5. Click the Fill tab to modify the background ll colors for the selected component.
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6. Enter eld information.

Field Description

Color/Top Color/Left Color Click this box to select a primary color as the background. The text description for this
option varies depending on the Gradient Mode you select.
 

No Fill Select this check box to clear any ll colors previously selected. If this check box is
selected, the other options on the Fill tab are disabled, except Color. Selecting a color
automatically clears the No Fill check box, enabling the other options.
 

Gradient Mode Select the positioning of the primary and secondary colors for the background from the
Gradient Mode drop-down menu. Using gradient coloring lets you merge two colors.
The following options are available.

◦ None—Select this option to use only the primary color as the ll color. If you select
None, the Gradient Color eld is disabled.

◦ Top to Boom—Select this option to merge the colors from the top of the
background to the boom.

◦ Left to Right—Select this option to merge the colors from the left of the
background to the right.

 

Gradient Color/Boom Color/Right
Color

Click this box to select a secondary color to merge with the primary color. The ll colors
then merge using the method dened in the Gradient Mode menu. The text description
for this option varies depending on the gradient mode you select.
 

Transparency (%) Select a percentage to dene how intense the ll colors are. A seing of 100% is
completely transparent, which prevents the ll colors from displaying. A seing of 0%
has no transparency, resulting in intense background colors. The selected percentage
is immediately reected in the Preview eld, so you can easily scroll through the
transparency percentages to nd a value that best suits your needs.
 

Preview
 

This area provides a sample of how the ll colors you select will appear on the report
background.
 

7. Click the Borders tab to modify the borders of a component.
8. Enter eld information.

Field Description

Color
 

Click this box to select a color for the border.
 

Style
 

Click this drop-down menu to select one of the following border styles: Solid, Dashed,
Doed, Inset, Outset, Double, Groove, Ridge, Rounded, or Separator. The Separator
option lets you add space around the component.
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Field Description

Weight
 

Click this drop-down menu to select the pixel size of the border. You can choose a
number between 1 and 10 pixels.
 

Preview
 

Use this area to dene the placement of the borders. Select any of the following buons
to place the borders, or click the area in the Preview white space where you want the
border.
 

Border buons
 

Click a buon to add the selected border aributes to the top, boom, left, right, or
all sides of the component. You can also add or remove borders from all sides of the
component.
 

9. Click Preview to preview the style with the changes you have made to fonts, margins, ll, and borders.
10. Click OK.

Related Topics
• Change Colors

Chart Styles Explorer  
You can apply chart styles to charts shown on reports to change their appearance. You can also create custom chart
styles if you have specic display requirements for your charts.

By applying a chart style, you can immediately change a chart’s fonts, colors, scales, gridlines, backgrounds, and other
display aributes. The Chart Styles explorer includes several predened chart styles, which you can apply to charts, and
allows you to create custom chart styles. You can then apply the same chart style to charts in dierent reports to ensure
that all the charts have a similar appearance.

Tip:  When conguring charts to display on the Browser User Interface, you can use any chart style you want,
but we suggest trying the Web Theme style which is congured for optimal display on web browsers.

The aributes dened in chart styles vary depending on the type of chart used in a report. Likewise, the chart style
options vary depending on the type of chart the style should be applied to.

Chart Type Description

Vertical bar charts display data as a series of vertical bars. Subtype options can display the chart with
single or stacked bars and as two- or three-dimensional.
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Chart Type Description

Horizontal bar charts display data as a series of horizontal bars. Subtype options can display the chart
with single or stacked bars and as two- or three-dimensional.
 

Pie charts display data as a percentage of a whole. Subtype options can display two- or three-
dimensional pie charts or doughnut charts.
 

Line charts display data as a series of points connected by a line. Subtype options can display the chart
as two- or three-dimensional.
 

Line/bar combo charts display both a line chart and a vertical bar chart. Subtype options can display
the chart with single or stacked bars and as two- or three-dimensional.
 

Area charts display data as areas on an x- and y-axis. Subtype options can display the chart as two- or
three-dimensional.
 

X-Y charts display data as a series of ploed points. Subtype options can display the ploed points as
points, lines, or bubbles and as two- or three-dimensional.
 

Radar charts display data in a radar format. Numeric values are ploed at markers on the perimeter.
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Chart Type Description

 

Stock charts display the minimum and maximum values for data. Subtype options can display the
chart using squares or lines to represent the high and low points of each plot.
 

Pareto charts display data in descending order with an ascending plot line for cumulative percentage.
Subtype options can display the chart as two- or three-dimensional.
 

Gauge charts display a numeric value as a percentage of a whole. Subtype options can display the
chart as a gradation bar or a simple color meter.
 
Gauge charts cannot be used in reports that contain non-aggregate columns.
 

Funnel charts display data as areas shown in ascending or descending order. Subtype options can
display two- or three-dimensional funnel or pyramid charts.
 

Gan charts display time lines for completion of scheduled tasks. Subtype options can display the
chart as two- or three-dimensional.

Related Topics
• How to Add and Edit Charts

Create or Edit a Chart Style  
Chart styles are customized using the Chart Styles editor.

When you edit a chart style and select a chart type, dierent buons are enabled based on the new chart type. For
example, the Bar Seings buon is enabled when editing a style for a vertical bar chart, whereas it is not enabled when
creating a style for a pie chart. The chart subtype, such as two- or three-dimensional and stacked or not stacked, also
impacts which options are enabled.

Tip:  The same ribbon options available on the chart styles editor are also available when you add a chart to a
custom report. This allows you to customize the display of an individual chart used in a report without creating
or modifying a chart style.
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When creating a chart style, a sample of the currently selected chart type and subtype is shown on the content pane.
The sample chart’s display changes depending on the options you select so you can quickly see how a chart that uses
the selected seings will appear.

Note:  After you select a chart type and subtype, you can follow the steps in this procedure in any order you
want. The steps in this procedure are listed according to the order of their associated buons on the ribbon.

1. Click Analytics on the navigation pane and then double-click Chart Styles Explorer.
2. To create a new chart style, click New on the ribbon.
3. To edit a chart style, right-click the chart style and select Edit.

The chart styles editor displays a default chart type.
4. Click Type on the Home tab to display the chart type menu.
5. Select the chart and chart subtype you want to congure for the chart style.

After you congure your chart style for the selected chart type and subtype, you can select other types to
congure your chart style for use with those types. This allows you to use the same chart style regardless of the
types of charts you add to reports, while ensuring the charts’ colors, fonts, and other aributes are consistent.

6. To congure three-dimensional seings for a chart style with a 3D subtype, click 3D Depth and 3D Angle on
the Home tab to enter values that impact how three-dimensional charts display.

Tip:  You can modify the three-dimensional seings for charts with 3D subtypes by right-clicking the
chart on the content pane and selecting Rotate. When you do so, your cursor changes and you can
move your mouse or other pointing device horizontally and vertically to change the chart’s three-
dimensional values. Click the left mouse buon to quit rotating the chart. The right-click menu also
gives you options to convert three-dimensional charts to two-dimensional charts, or two-dimensional
charts to three-dimensional charts, as long as the chart type includes 3D subtypes. This right-click
menu is also available when creating or viewing reports.

Buon Description

3D Depth
 

Click this buon and enter a number for the extent of the chart’s three-dimensional
eect. A value of 0 removes the 3D appearance from the chart, where as a seing of 125
maximizes the eect.
 

3D Angle
 

Click this buon to enter values for the chart’s horizontal and vertical angles.
 

X Angle
 

Enter a value from 0 to 180 degrees in this eld. This value determines the vertical
rotation of the chart.
 

Y Angle
 

Enter a value from 0 to 180 degrees in this eld. This value determines the horizontal
rotation of the chart.
 

7. To congure colors, styles, borders, and other seings for the bar, line, or gauge elements in charts, click the
Home tab and click Bar Seings, Line Seings, or Gauge Seings.
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Buon Description

Bar Seings
 

Click this buon to customize the display of the bar elements for chart types that include
bars.
 

Bar Outline
 

Select this option and then select the type of outline you want around the individual
bars in the chart. You can choose from the following options:

◦ None—The bars have no outline.

◦ Lighter—The bar outline is a lighter shade of the bar’s color.

◦ Darker—The bar outline is a darker shade of the bar’s color.

◦ Color—The bar outline is a specied color.

 
Choosing Color enables the Outline Color option. Select this to open the color menu
where you can select a color for the outline.
 

Bar Style
 

Select this option and then select the style you want for the bars in the chart. You can
choose Block, Cylinder, Wedge, Emboss, or Light to Dark.
 

Multicolor Series
 

Select this option to make the bars in dierent series use dierent colors. When this
option is not enabled, the bars in dierent series are shown using the same set of colors.
 

Line Seings
 

Click this buon to customize the display of the line elements for chart types and
subtypes that include lines.
 

Line Width
 

Select this option and then select the number of pixels you want for the line’s width.
Options include widths from one to ten pixels.
 

Symbols
 

Select this option and then select the symbol you want to place on the line to mark data
points. You can choose None, Square, Circle, or Triangle.
 

Gauge Seings
 

Click this buon to customize the display of the gauge for gauge chart types.
 

Gauge Color
 

Select this option to open the color menu to select a color for the gauge. You can also
select No Value from the menu to use the default color.
 

Border Color
 

Select this option to open the color menu to select a color for the gauge’s outline. You
can also select No Value from the menu to use the default color.
 

Show Numeric Identier
 

Select this option to display a numeric indicator on the gauge which shows the actual
value represented on the gauge.
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Buon Description

 

Color Ranges
 

Select this option to open the Color Range window where you can dene dierent colors
to use for dierent value ranges on the gauge.
 

8. To dene color ranges for a gauge chart, click Gauge Seings on the Home tab and select Color Ranges.
a. Click Add Range to add a color range.
b. Enter eld information.

Field Description

Add Range
 

Click this text to add a range. Before you add a range, the Color Ranges
window does not show any ranges and Add Range is the only option
available.
 

Minimum
 

Enter the percentage value the range should begin at. For example, a gauge
with three color ranges could have a range that begins at 34%.
 

Maximum
 

Enter the percentage value the range should end at. For example, a gauge
with three color ranges could have a range that ends at 66%.
 

Start Color
 

Click this box to open the Color window and select a color for the beginning
of the range.
 

End Color
 

Click this box to open the Color window and select a color for the end of the
range.
 

Remove Range
 

Click this text to remove the range shown next to the text.
 

c. Click OK to save the color ranges.
Sample ranges are shown in the Color Ranges window here.
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Color ranges are unique to gauge charts and let you show ranges of dierent values on the chart in dierent
colors.

9. To select a color scheme for the chart style, click Color Scheme on the Home tab and select the item you want
from the color scheme menu.

Customizable color schemes are available for all chart types except gauge charts. Color schemes can be used to
dene the colors used for the chart. See Create a Color Scheme.

10. To dene the placement of labels, such as titles and legends, click the Layout tab and click the buon in the
Labels group that corresponds to the label you want to congure.

Label Description

Title
 

Click this buon to select options for the chart’s title. This label displays the chart’s title
dened when you add a chart to a report. You can choose not to show this label, or you
can show it at the left, right, top, or boom of the chart.
 

Legend
 

Click this buon to select options for the chart’s legend. This label displays a legend to
identify the chart’s contents. You can choose not to show this label, or you can show it at
the left, right, top, or boom of the chart.
 

Category Axis Title
 

Click this buon to select options for the chart’s category axis title. This label identies
the chart’s category axis. You can choose to show it or not show it.
 

Value Axis Title
 

Click this buon to select options for the chart’s value axis title. This label identies the
chart’s value axis. You can choose to show it or not show it.
 

Data Labels
 

Click this buon to select options for the chart’s data labels. Data labels can be displayed
on the chart’s bars, lines, and other display components to show the actual values
represented in the chart. You can choose to show data labels or not show them.
 

Exception Box
 

Click this buon to select options for the chart’s exception box. This label describes the
exceptions shown in the chart if the chart’s data includes exceptions and the report is
congured to show exceptions on the chart. You can choose to show this label at the
left, right, top, or boom of the chart.
 

11. To congure scale options for the chart style, click Value Scale on the Layout tab and select from the options
presented.

Option Description

Primary Scale
 

The options in this section let you show the primary scale, rotate the scale’s labels, and
choose whether to congure the scale’s range manually. You can also choose to have
these options congured automatically.
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Option Description

Show
 

Select this option to display the primary scale on the chart. By default, the primary scale
is displayed.
 

Automatic
 

Select this option to automatically determine the range of the scale based on the range
of values in the data shown on the chart.
 

Manual
 

Select this option to manually congure the range shown on the primary scale. When
you select this option and hover over it, Scale Start and Scale End elds appear. Enter
the minimum value you want for the scale in the Scale Start eld and the maximum
value you want in the Scale End eld.
 

Rotate Labels
 

Select this option and then select a degree to rotate the label text. Your choices are
None, 15, 30, 45, 0, -15, -30, and -45 degrees (clockwise).
 

Secondary Scale
 

The options in this section let you congure the secondary scale for the line values
shown on line/bar chart types.
 

Show
 

Select this option to display the secondary scale on the chart. By default, the secondary
scale is not displayed.
 

Automatic
 

Select this option to automatically determine the range of the scale based on the range
of values in the data shown on the chart.
 

Manual
 

Select this option to manually congure the range shown on the secondary scale. When
you select this option, Scale Start and Scale End elds appear. Enter the minimum value
you want for the scale in the Scale Start eld and the maximum value you want in the
Scale End eld.
 

Rotate Labels
 

Select this option and then select a degree to rotate the label text. Your choices are
None, 15, 30, 45, 0, -15, -30, and -45 degrees (clockwise).
 

Position
 

The options in this section let you choose where to place the primary scale on the chart.
 

Primary Scale Right
 

Primary Scale Left
 

Select one of these options to place the primary scale on the right or left side of the
chart. By default, the primary scale is displayed to the left of the chart.
 
These options are enabled only for chart types that display data vertically.
 

Primary Scale Top
 

Select one of these options to place the primary scale at the top or boom of the chart.
By default, the primary scale is displayed at the boom of the chart.
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Option Description

Primary Scale Boom
 

 
These options are enabled only for chart types that display data horizontally.
 

Use Logarithmic Scale
 

Select this check box to use a logarithmic scale based on your report data.
 

12. To congure category and value grid lines shown on the chart, click Category Grid Lines or Value Grid Lines
on the Layout tab.

Option Description

Scale
 

The options in this section let you choose whether to use automatic or manual osets
for the major and minor grid lines shown on the chart. The osets determine the
spacing between the grid lines.
 

Automatic
 

Select this option if you want the osets between the major and minor grid lines shown
on the chart to be congured automatically.
 

Manual
 

Select this option to manually specify the osets for the chart’s grid lines. When you
select this option, Major Oset and Minor Oset elds are displayed. Enter the numeric
oset value you want for the major grid lines in the Major Oset eld, and the oset you
want for the minor grid lines in the Minor Oset eld.
 

Display
 

The options in this section let you show or hide major and minor grid lines on the chart.
Grid lines can make it easier to identify values on the chart.
 

Show Major
 

Select this option to display major grid lines on the chart.
 

Major Color
 

Select this option to open the color menu where you can choose the color you want for
the major grid lines.
 

Show Minor
 

Select this option to display minor grid lines on the chart.
 

Minor Color
 

Select this option to open the color menu where you can choose the color you want for
the minor grid lines.
 

Show Left
 

Select this option to show grid lines along the left side of the chart.
 
This option is not available on the Value Grid Lines buon.
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Option Description

Left Color
 

Select this option to open the color menu where you can choose the color you want for
the grid line along the left side of the chart.
 
This option is not available on the Value Grid Lines buon.
 

Boom Color
 

Select this option to open the color menu where you can choose the color you want for
the grid line along the boom of the chart.
 
This option is not available on the Category Grid Lines buon.
 

13. To congure options for tick marks shown on the chart’s scale, click Tick Marks on the Layout tab, and select
the options you want.

Option Description

Scale
 

The options in this section let you choose whether to use automatic or manual osets
for the major and minor tick marks shown on the chart’s scale. The osets determine
the spacing between the tick marks.
 

Automatic
 

Select this option if you want the osets for the scale’s major and minor tick marks to be
congured automatically.
 

Manual
 

Select this option to manually specify the osets for the scale’s major and minor tick
marks. When you select this option, Major Oset and Minor Oset elds are displayed.
Enter the numeric oset value you want for the major tick marks in the Major Oset
eld, and the oset you want for the minor tick marks in the Minor Oset eld.
 

Display
 

The options in this section let you show or hide major and minor tick marks on the
chart’s scale.
 

Major Tick Marks
 

Select this option to show the major tick marks on the chart.
 

Minor Tick Marks
 

Select this option to show minor tick marks on the chart.
 

14. To customize the fonts, borders, and backgrounds of dierent sections of the chart, click the Format tab.
a. Click the section of the chart you want to congure on the content pane or, if you know the name of the

chart section you want to congure, select it from the Current Selection drop-down menu.
The following chart sections are available, though not all sections are available for all chart types.

- Chart Area
- Grid Area
- Title
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- Legend
- Category Axis Labels
- Category Axis Title
- Value Axis Title
- Primary Scale Labels
- Secondary Scale Labels
- Data Labels
- Exception Box

b. Select from the options on the Format tab’s Format group.

Buon Description

Border
 

Click this buon to select a border style for the selected section. The available
options are:

- None

- Thin

- Medium

- Thick

- Dashed

 
To select a color for the border, select Border Color from the menu to open
the color menu.
 

Shadow
 

Click this buon to select a shadow style for the selected section’s border.
The available options are:

- None

- Thin

- Medium

- Thick

 
To select a color for the shadow, select Shadow Color from the menu to open
the color menu.
 

Background
 

Click the arrow on this buon to open the color menu where you can select a
background color for the selected section of the chart.
 

Transparency
 

Click this buon to enter a percentage to dene how intense the background
color is for the chart’s grid area. A seing of 100% is completely transparent,
 which prevents the ll colors from displaying. A seing of 0% has no
transparency, resulting in intense background colors. The selected
percentage is immediately reected on the sample chart, so you can easily
scroll through the transparency percentages to nd a value that best suits
your needs.
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Buon Description

Gradient
 

Click this buon to select the type of gradient you want for the background of
the chart area section. You can use gradient color to customize a background
by blending two colors. Your options are:

- None

- Left to Right

- Top to Boom

 
To select a gradient color to blend into the background color, select Gradient
Color to open the color menu.
 

Font buons
 

Select the font, font size, and other aributes from these buons.
 

15. To congure seings for a dierent chart type or subtype, repeat steps 3 through 14.
16. Click Save.

Related Topics
• Change Colors

Create a Color Scheme  
The Color Schemes explorer lets you view standard color schemes used in conjunction with chart styles.

You can copy standard color schemes and edit the copies, or you can create your own custom color schemes.

Tip:  When conguring charts to display on the Agent Browser UI, you can use any color scheme you want, but
we suggest trying the Web Theme scheme which is congured for optimal display on web browsers.

1. Click Analytics on the navigation pane and then double-click Color Schemes Explorer.
The explorer opens, displaying the current color schemes.

2. Click New.
The New Color Scheme window opens, populated with default colors.

3. To change a particular color, click the box with the color to open the Color window. See Change Colors.
4. Enter the transparency value for the color scheme in the Transparency eld.

A transparency value of 0 displays a solid color, and a value of 255 is completely transparent with no color.
5. Click Save.

Images Explorer  
You can add or replace images in reports and dashboards using the Images explorer.
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Photos and other images can be uploaded to use in reports and dashboards. For example, your organization’s logo can
be added as an image and then added to custom reports. See Add an Image to a Report Section for information about
adding images to reports area backgrounds or Add an Image for information about adding images to dashboards.

The images used with reports and dashboards can be added and replaced using the Images explorer. The ability to
replace images is helpful when an image, such as a corporate logo, is modied. After the image le is replaced, the
reports and dashboards with the old image automatically use the new image.

Note:  Images can also be copied, renamed, or deleted using right-click functionality.

Add an Image  
You can add images using the Image explorer.

1. Click Analytics on the navigation pane, and then double-click Images Explorer.
2. Click New.
3. Click Select One or More Images to open a window where you can select the images you want to add. You can

add .bmp, .jpg, .gif, and .png le types.
4. Select the image you want to upload. You can select multiple images by pressing Ctrl when selecting them.
5. Click Open.
6. Click Save. When saving a single image, you can specify a new name for the image. When saving multiple

images, the original image names are retained.

Replace an Image  
You can replace an image with an updated image using the Images Explorer.

1. In the Images explorer, right-click the image you want to replace and select Open.
2. Click Select a Dierent Image.

A window opens where you can select the new image.
3. Select the image you want to replace the existing image with.
4. Click Open.
5. Click Save.

Create a Text Field  
The Text Fields explorer lets you create text elds you can add to custom reports and dashboards.

When you create a text eld, you can specify the eld’s text, fonts, borders, colors, and margins. You can also adjust
these seings after you add the eld to a report or dashboard. See Add a Text Field to a Header or Footer or How You
Add Images and Text Fields to Dashboards.

For example, you could create a text eld with your organization’s name, using your organization’s preferred fonts and
colors, which you could add to your reports’ titles. Since the text elds can be edited after they are added to reports, you
can also create a template text eld with your customized seings and change the wording in the eld as necessary.

Using the Text Fields explorer, you can edit, copy, delete, and rename text elds using right-click functionality. You can
also create new text elds.

1. Click Analytics on the navigation pane and then double-click Text Fields Explorer.
2. Click New.
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A new text eld opens on the content pane.
3. Enter eld information.

Field Description

Text*
 

Enter the text you want to display in this eld. This text also serves as the text eld
name.
 

Text Alignment
 

Click this drop-down menu to select the horizontal alignment for the text in the text
eld. Options are Left, Center, and Right.
 

Line Alignment
 

Click this drop-down menu to select the vertical alignment for the text in the text eld.
Options are Top, Center, and Boom.
 

Anchor Style
 

Click this drop-down menu to select the anchor style for the eld. See Specify an Anchor
Style for a Text Field.
 

4. Click the Size tab.
5. Enter eld information.

Field Description

Best Fit
 

Select this option to have the size of the text eld automatically adjusted to best t the
available space in the report.
 

Specic Size (Pixels)
 

Select this option to manually enter the specic width and height seings for the text
eld. Any text in the eld boundaries that exceeds the size of the eld is clipped.
 

6. Click the Font tab to select the font seings for the text eld. See Change Font Aributes from the Font Tab.
7. Click the Margins tab to dene the amount of space surrounding the text in the text eld.
8. Select the number of pixels between the text and each of the four text eld margins.
9. Click the Fill tab to dene the background ll colors for the text eld.

10. Enter eld information.

Field Description

Color/Top Color/Left Color
 

The text description for this option varies depending on the gradient mode you select.
Click this box to select a primary color as the background.
 

No Fill
 

Select this check box to clear any ll colors previously selected. If this box is selected, the
other options on the Fill tab are disabled except Color. Selecting a color automatically
clears the No Fill check box, enabling the other options.
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Field Description

Gradient Mode
 

Select the positioning of the primary and secondary colors for the background from the
Gradient Mode drop-down menu. Using gradient coloring lets you merge two colors.
The following options are available.
 
None—Select this option to use only the primary color as the ll color. If you select
None, the Gradient Color eld is disabled.
 
Top to Boom—Select this option to merge the colors from the top of the background
to the boom.
 
Left to Right—Select this option to merge the colors from the left of the background to
the right.
 

Gradient Color/Boom Color/Right
Color
 

The text description for this option varies depending on the gradient mode you select.
Click this box to select a secondary color to merge with the primary color. The ll colors
then merge using the method dened in the Gradient Mode menu.
 

Transparency (%)
 

Select a percentage to dene how intense the ll colors are. A seing of 100% is
completely transparent, which prevents the ll colors from displaying. A seing of 0%
has no transparency, resulting in intense background colors. The selected percentage
is immediately reected in the Preview area, so you can easily scroll through the
transparency percentages to nd a value that best suits your needs.
 

Preview
 

This area provides a sample of how the ll colors you select will appear on the text eld’s
background.
 

11. Click the Borders tab to dene the borders for the text eld.
12. Enter eld information.

Field Description

Color Click the color box to select a color for the border.
 

Style Click this drop-down menu to select one of the following border styles: Solid, Dashed,
Doed, Double, Inset, Outset, Groove, Ridge, Rounded, or Separator. The Separator
option lets you add empty space around the text eld.
 

Weight Click this drop-down menu to select the pixel size of the border. The border weight can
be from 1 to 10 pixels.
 

Preview This area denes the placement of the borders you dene. Select any of the border
buons to place the borders or click the area in the Preview white space where you want
the border.
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Field Description

 

Borders Click a border buon to add the selected border aributes to the top, boom, left, right,
 or all sides of the component. You can also add or remove borders from all sides of the
component.
 

13. To preview the text eld, click Preview.
14. Click Close.
15. Click Save.

Related Topics
• Change Colors

How You Change Fonts and Colors  
Certain items you edit in explorers include options to change font aributes or add colors.

The methods to dene fonts and colors are generally the same, regardless of the item you’re editing or the explorer
you’re using.

Change Font Aributes from the Font Tab  
When customizing text elements in Analytics, you can specify font aributes to change the display of the text. Font
aributes can be selected from the ribbons in certain editors, such as the chart styles editor, or from a Font tab on a
window in other areas.

The same options are available from the ribbon or the tab. Some editors give you access to font aributes from both the
ribbon and the tab, allowing you to change font aributes from either location. This procedure describes the options
available on the Font tab. However, you can also set these options from the ribbons of most editors in Analytics, such as
the Chart Styles editor.

1. Click the Font tab.
2. Enter eld information.

Field Description

Font
 

Click this drop-down menu to select a font.
 

Style
 

Select the check boxes for the style aributes you want. You can select multiple
aributes to apply to the font: Regular, Bold, Italic, Underline, Strikethrough, and All
Caps.
 

Size
 

Click this drop-down menu to select the point size of the font.
 

Color Click the color box to select a color for the font. See Change Colors.
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Field Description

   

Preview
 

Click this buon to preview the font using the options you select.
 
This buon is not available on all Font tabs.
 

3. Click OK.

Change Colors  
You can select colors for many objects in Analytics, such as text labels and report backgrounds.

When selecting colors from a tabbed window, the Color window displays. When selecting colors from a ribbon, the color
menu is displayed. Both give you the same options, though they present them in slightly dierent ways. This procedure
explains how to select colors and dene custom colors using both the color menu and Color window.

1. To select a color using the menu, click the color you want to use.
The color is applied to the object you are editing.

2. To select a color using the window:
a. Click the color you want.
b. Click OK.

The color is applied to the object you’re editing.
3. To dene a custom color from the window:

a. Click Dene Custom Colors.
The window expands to show custom color options.

b. Click anywhere in the color palee or enter the HSL (hue, saturation, lumination) or RGB (red, green, blue)
components in the appropriate text boxes to dene your custom color.
The HSL color model denes the hue, saturation, and lumination of the color.

- Hue—The hue is the pigment of the color and has a value between 0 to 359 degrees.
- Saturation—The saturation is measured as a percent from 0 to 100 and species the vividness of a

color.
- Lumination—Lumination is the amount of white in the color and is a value from 0 to 100 percent.

The RGB color model denes the amount of red, green, and blue light the color contains. RGB values can
be between 0 and 255. For example, when all components are set to 255, the color is white, and when all
are set to 0, the color is black.

c. Click Add to Custom Colors. The color is added to your custom colors.
d. Click OK to apply the color you selected or created to the component you’re dening.

4. To view additional standard colors or to create a custom color from the color menu, click More Colors.
a. To choose a standard color from the window, click the color you want and click OK to apply the color to

the object you’re editing.
b. To dene a custom color, click the Custom tab.

Custom colors are dened on the Custom tab in the same way they are dened on the Color window.
c. Click OK to apply the custom color to the object you’re editing.
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Creating Basic Custom Reports  

Overview of Creating Basic Custom Reports  
You can create new reports using Oracle RightNow Analytics Cloud Service (Analytics). While this can be a complex
process, learning how to create a basic report will help you understand the tools you need to create more complex
reports.

When creating reports, you can use advanced features such as multiple output levels, linked reports, calculations, data
exceptions, variables, computed elds, and custom scripts. These reports can take time to plan or may require input
from several people. However, you can quickly create reports that fulll most of your reporting needs.

Related Topics
• Overview of Custom Reports

How to Plan a Basic Custom Report  
No maer how simple or complex a custom report is, there are certain guidelines to follow to help you create the report
you want.

Since each custom report you create can output dierent data and include dierent components, you may want to
design your report before you start to create it. This helps determine what steps you need to take to create the report
you want. We recommend considering the following questions before you create your report.

• What audience will view or use the report? This determines which report layout you use since some layouts
include charts, titles, and other information. See Apply a Layout to a Dashboard and Apply a Layout to an
Output Level.

• What information do you want the report to return? This determines the elds to include in the report’s output.
See Overview of Report Output Columns.

• What elds do you want to be able to search on when running the report, and what information should be
excluded? This determines the report’s xed and runtime selectable lters. See Overview of Report Filters.

• Do you want to be able to drill down on any elds to view additional information? This determines if multiple
output levels or linked reports need to be congured. See Overview of Report Output Levels and Overview of
Linked Reports.

• How do you want the information that is returned to be ordered? This determines the sorting options that you
apply to the report. See How You Change Report Sort Order.

• Who should have access to run or edit the report? This determines if the report should be made public and
what permissions are applied to the report. See Set Report Permissions.

Tip:  If an existing report is similar to a report you want to create, you can copy the existing report and then
edit the copy to create your new report. To view descriptions of existing reports, you can generate a catalog of
reports. See Create a List of Reports. For information about nding and copying reports, see Overview of the
Analytics Explorers. For information about viewing the contents of a report, see View a Report Denition.
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Overview of Creating Custom Reports  
After you understand what your report should contain, you create it on the report designer.

The procedures listed here demonstrate the basic steps that are required to create most reports. While the sample
report might not be useful to your organization, knowing how to create a report such as this will help you create reports
your organization needs.

In this sample report, you will see the number of unresolved and updated incidents in each incident queue. You will
also be able to drill down on the information in the rst level to open a second output level to view details about the
incidents in each queue.

To create the report, you will follow a number of basic steps.

• Open the report designer. See Open the Report Designer.

• Add columns to the report. See Add Output Columns to a Report.

• Add another output level to the report. See Add a Second Output Level to a Report.

• Add lters to the report. See Add a Search Filter to a Report.

• Save the report. See Save a Custom Report.

Related Topics
• Create a Custom Report (video)

Open the Report Designer  
The report designer gives you access to all the tools you need to create basic or more complex reports.

1. Do one of the following:

◦ Click Analytics on the navigation pane, double-click Reports Explorer, and then click New Report.

◦ If your navigation set is congured to add new reports from the le menu, click File and then select
Report. See Asset Workspaces.

2. Select the type of report you want to build: Grid report, Standard report, or Standard report with Chart.
Since the sample report will primarily be used internally by sta members to work with records, select Grid
report.

Note:  Grid reports are most commonly used on the Service Console to list records that sta members
can open for editing. The other report types are generally used to present summaries of data inside or
outside of your organization. If you decide you want a dierent report type after you start creating a
report, you can change it from the Report Layouts buon on the Home tab.

After selecting the report type, the report design center opens where you create your report. The report
designer consists of the ribbon, the design surface, where report content is located, and the data dictionary,
where you can select from the database’s tables and elds.

Related Topics
• Create a Custom Report (video)
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Add Output Columns to a Report  
In this procedure, we will add two columns to the report’s rst output level, displaying incident queues and the number
of incidents in each queue.

1. Expand the All Tables tree on the data dictionary and then select Incidents.
2. Select Queue (queue_id) on the right side of the data dictionary and drag it to the design surface. The eld

is added to the report as a column and is automatically named Queue, but you can right-click the column to
change the name and customize other options.

3. On the data dictionary, scroll down to the Functions tree and expand it.
4. Select Aggregate Functions and then drag count(expr) onto the design surface. The Column Denition

window opens where you select the eld you want counted.

We will edit the column’s expression to specify what records we want counted. In this example, we want to count
the incidents in each queue.

5. On the left side of the window, expand  Current Dataset > Incidents .
6. Scroll down to Incident ID (i_id) and drag it to the text between the parentheses on the right side of the

window. After you do this, the column’s expression will be count(incidents.i_id).

We want to count the records using this eld since it is a unique identier for incidents as no two incidents
share the same ID number.

7. To change the name of the column you're adding, enter the name you want in the Heading eld. For our
example, you can type Number of Incidents.

8. Click OK.
The new column automatically displays a count of all incidents in each incident queue.

745



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

The rst output level of the sample report now has two columns displaying incident queues and the number of
incidents in each queue. For more information about adding output columns to reports and the types of columns you
can add, see Overview of Report Output Columns.

Add a Second Output Level to a Report  
Now we will add a second output level to the report that you can drill down into to view details about the incidents in the
queues.

For an overview of output levels, see Overview of Report Output Levels. Alternatively, if you already have a report that
returns the information you want to see in the drill-down level, you can link the reports together instead of adding
another output level. See Overview of Linked Reports.

1. Click the Level tab and then click Add Drilldown.

You can enter a dierent name for the new output level in the Name eld, add notes about the level in the
Description eld, and change other options that are described in Overview of Report Output Levels.

As you review the options in the Drilldown Seings area of the window, notice that the drill-down lter is
automatically set to incidents.queue_id. When you use the report and click a drill-down link on the rst level
of the report, the second output level knows to display only information related to the queue in the row you
clicked. For more complex reports, the drill-down lter can be changed, but it is not necessary to do so here.

The link you click when using the report is also automatically set to incidents.queue_id. However, for our
sample report, we will make the incident count column the link we click to drill down.

The Level Seings window opens, displaying information about the new output level.
2. Click the Link drop-down menu and select count(incidents.i_id).
3. Click OK.

Tip:  If your report has multiple output levels, you can click the Level drop-down menu at the top of
the design surface and select the level you want.

You can now drag elds from the data dictionary onto the design surface to add columns to the second level of the
report. Since this output level is intended to display details about the incidents, you could add elds from the incidents
table such as Reference #, Subject, Assigned Account, and Date Created. You can also add elds from the contacts table
to view information about the contacts who submied the incidents. See Add Output Columns to a Report.

Related Topics
• Create a Custom Report (video)

Add a Search Filter to a Report  
Next, we will add a xed lter to return only unresolved and updated incidents in the report.

Fixed lters prevent reports from querying more information than you need in the report. You could also add runtime
selectable lters to the report to return only incidents created in a certain time period, assigned to particular sta
accounts, or that match other criteria you specify. Unlike xed lters, runtime selectable lters let you select the values
you want when you run the report.

1. Click the Home tab and then click Add Filter.
The Add Filter window opens.

2. If you want to specify a name for the lter, enter a name in the Name eld.
This name is used only on the report designer. If you do not specify a name, the lter’s database eld is used
instead.

3. Clear the Make this Filter Selectable at Run Time check box.

746

https://www.youtube.com/embed/DdAac5akcBQ?rel=0&autoplay=1


Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Note:  If we were creating a runtime selectable lter, we would leave this check box selected and enter
a lter name in the Label this Filter eld that sta members see when running the report. We could
also select the Required check box for runtime selectable lters to force the report’s users to specify a
lter value before they can run the report.

4. In the Denition section, right-click in the Expression eld and select  Incidents > Status status_id  .
This is the database eld we are using to lter the report’s output by.

5. Click the Operator drop-down menu and select In List.
6. Choose the items you want to include in the search.

When you use the In List operator, all items are selected by default. Clear the check box next to each item you
do not want to include in the initial search or clear the Select All check box and select the check box next to
each item you want to include. For our example, select Unresolved and Updated. The report will include only
incidents with one of these statuses. Since the lter is selectable at runtime, you can change the search options
when you run the report.
To prevent menu options that are irrelevant to the report’s audience from being available in searches, click
Customize and clear the check boxes next to the options you do not want to display.

7. Click OK.

Related Topics
• Overview of Report Filters

• Change Menu Filter Options

• Create a Custom Report (video)

Save a Custom Report  
The nal step in creating the report is to save it to a location where the report’s audience can access it. After you save
the report, your sta members can open it, assuming they have permission to do so.

1. Click the arrow next to Save on the Quick Access toolbar and select Save and Close. The Save As window
opens where you specify the name of the report and where you want it saved.

2. Select the Public Reports folder or a custom subfolder beneath it. Reports that are saved in the My Reports
folder are accessible only by you.

a. To create a custom subfolder, right-click Public Reports, select New Folder, and enter the name you
want for the folder.

3. Enter the name for the report in the Name eld. The name can be up to eighty characters long.
4. Click OK.

Your sta members can now access the report from the Reports explorer or you can add the report to their navigation
sets. You can edit the report whenever you want to add more columns, lters, or output levels. You can also add
advanced functionality such as column calculations, variables, inline editing, and other options. If you want to show the
information in the report to a wider audience, you can also change the report’s layout and add charts, text elds, and
images.

If you encounter problems when you try to run a custom report, you can examine it using the report analyzer. This will
help you determine the cause of the problem, such as the report querying tables that it does not need, or lacking lters
to reduce the amount of data being read.
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Related Topics
• Overview of Navigation Sets

• Overview of Custom Reports

• How to Review Report Performance

• Set Report Permissions

• Create a Custom Report (video)

Custom Reports  

Overview of Custom Reports  
Creating custom reports gives you the exibility to output the information you need in the format you want.

Custom reports can be simple, pulling data from one table and returning data from the same table, or they can be
complex, pulling data from several tables, ltering it, and returning tabular and chart information in multiple output
levels or linked reports.

When creating a custom report, you can select the database elds you want, add calculations and functions to the elds,
and create xed and runtime selectable lters to nd the exact records you want. You can also add charts and text to
your report, and specify the display and data options used when your report is opened. This ensures the information
presented in your report is clear and accessible to your audience.

Overview of the Report Designer  
You create and edit custom reports from the report designer.

All the tools you need to create a report are available from one location. You can also access optional items, such as
chart styles and color schemes you have congured in the other Oracle RightNow Analytics Cloud Service (Analytics)
explorers, from the report designer to enhance your reports.

You can customize reports based on your organization’s needs using the report designer’s ribbon, data dictionary, and
design surface components.

Related Topics
• Overview of the Analytics Explorers

• Open the Report Designer

• Import a Report from an XML File

Open the Report Designer  
Use the report designer to create and edit custom reports.

In most cases, you will open the report designer from the Reports explorer. However, if you want to create a new report
and your navigation set is congured to add reports from the le menu, you can click File and select Report.

748

https://www.youtube.com/embed/DdAac5akcBQ?rel=0&autoplay=1


Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Note:  If your site has an Agent Browser User Interface associated with it, a message displays stating that not
all Analytics features are supported by the interface. Click OK to continue.

After you open the report designer, you can increase the amount of space on the design surface by hiding the data
dictionary or elements on the design surface. When you need an item that is hidden, you can display it again.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. To edit an existing custom report, right-click the report and select Edit.

The report designer opens.
4. To create a report, click the New Report buon.

A window opens where you select the report’s initial layout.
5. Click the name of the layout you want to use for the report.

Options include Grid Report, Standard Report, and Standard Report with Chart.
When you select a layout, the report designer opens with the selected layout.

6. To create a copy of a report from another interface by importing a report denition, click Import Existing
Report Denition. See Import a Report from an XML File.

Related Topics
• Overview of Navigation Sets

• Reports Explorer

• Overview of Report Designer Components

• Import a Report from an XML File

• Create a Custom Report (video)

Import a Report from an XML File  
Using existing report denitions allows you to create duplicates of complex custom reports from other interfaces
without manually re-creating the reports.

If you have multiple interfaces, you can use report denitions saved in XML les to create reports on other interfaces.
If you have previously exported segments, you can also import these to create custom reports. Since reports are not
shared between interfaces, you must export a report from one interface and import it into another to have the same
report available in multiple interfaces.

Note:  When you import a report denition to create a report on a dierent Oracle Service Cloud site, items in
the report denition that do not exist in the database where you import the report, such as custom elds, will
display in the new report but will not display data. You must edit the new report to modify or delete items that
do not correspond to existing elds in the database.

When you import a report, the permissions from the imported report are not changed. However, the owner of the report
is changed to the sta member who imports the report.

1. Click New Report on the Report explorer’s ribbon to select the report layout.
2. Click Import Existing Report Denition.
3. Select the XML le containing the report denition.
4. Click Open.

The imported report opens on the report designer where you can modify it.
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If you import a report that includes custom object record commands into a site that has custom objects with
dierent names or ID numbers, a window opens where you can match the custom objects referred to in the
imported report to the custom objects on the site.

If the XML le you import contains a custom script, a dialog displays where you can choose to import the script
or not. See Create a Custom Script in a Report.

5. Save the new report.

Related Topics
• Overview of Custom Objects

• Export a Report Denition to an XML File

Overview of Report Designer Views  
There are four dierent ways to view a report as you edit it in the report designer.

Each view presents your report in a dierent way and gives you access to dierent ribbon tabs.

• Report View—This view shows you the report just as your sta members will see it when they open it. The
report presents real data and is particularly useful when you want to preview a report you’re editing. This view
does not let you add column calculations, adjust column formaing options, or use action links.

• Layout View—This view is similar to the report view and is also useful for previewing reports. However, unlike
the report view, this view lets you select individual columns in the report and apply formaing options to the
columns. For example, if you want to add conditional formaing to a column to highlight data that meets
certain criteria in the column, you could select the layout view, select the column, and congure conditional
formaing for the column.

Note:  When you select the report or layout view, a message appears if your report queries too much data.
While you can save the report, we recommend that you add xed lters or reduce the number of tables in
the report to ensure that the report runs eciently. In addition, any custom scripts added to the report are
checked for PHP errors when you select these views. If any problems are found, a message displays providing
information about the error. The report can be saved, but the custom script will be disabled when users run
the report. See Create a Custom Script in a Report.

• Design View—This is the default view when you open the report designer. This view gives you access to the
tools you need to create and edit your report on the design surface.

• Data Set View—This view shows your report in a textual design space. You can add columns, lters, and
variables using this view, just as you can when using the design view, but you cannot add graphic elements,
such as charts, images, or text elds. The data set view is particularly helpful if you want to view text
descriptions of your report’s contents, and access dierent report components to edit them. In addition, you
can dene the lter label that displays in the Quick Search by selecting the lter you want to display and moving
it to the top of the list.

Related Topics
• Specify Report Views

• Create a Custom Report (video)

Specify Report Views  
When you open the report designer, you can choose to use one of four views to look at your report.

1. Edit a report.
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By default, the report opens in the design view.
2. Click the arrow on the Views buon on the Home tab and select the view you want.

The report display is updated to use the view you select.

Related Topics
• Overview of Report Designer Views

Overview of Report Designer Components  
The majority of the tasks you perform when creating or editing a custom report are done through the ribbon, design
surface, and data dictionary components of the report designer.

These components provide access to the data, report sections, parameters, and other items you use to create and edit
custom reports.

The ribbon is shown at the top of the content pane and gives you access to the tools you need to create and edit
reports. The design surface is shown in the middle of the content pane and shows the data area and other elds. The
data dictionary is shown at the boom of the content pane and gives you access to the elds in the database that you
can use in your custom reports.

Report Designer Ribbon  
The report designer’s ribbon includes eight tabs from which you can access options to create or edit a report.

The ribbon’s tabs vary depending on which view you use and the object selected on the design surface. For example,
when editing a report using the design view, you can select the Home, Display, Insert, Level, and Page Setup tabs to
add lters and report levels, insert charts, and modify the report’s display. The Design, Format, and Options tabs are
displayed when you select objects on the report, giving you options to edit the selected object. The data set view gives
you similar options, though the Insert tab is not available. Fewer tabs are available when using the report and layout
views.

Tip:  You can minimize the ribbon when editing a report by double-clicking the active tab. Click the tab to
temporarily display the buons on the tab or double-click the tab again to maximize the ribbon.

Each tab on the ribbon has one or more groups containing buons you can use to modify the report or items on the
report. Some groups have icons to the right of their names that you can click to open a window. For example, the Page
Setup tab has Print, Background, and Display groups. You can click the small icon shown on the Background group to
open the Display Options window.

Windows give you access to the same features you can access from the ribbon. However, the windows group the
options dierently, and sometimes contain additional options not available from the ribbon.

When explaining features that can be accessed from a window or the ribbon, we describe the feature using the window,
but keep in mind that the ribbon’s buons provide shortcuts to most of the same features available on windows.

Related Topics
• Overview of the Report Ribbon
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Report Designer Home Tab  
The report designer’s Home tab gives you access to options that impact the entire report.

From the Home tab, you can select report layouts, view or export a denition of the report, schedule the report to be
sent out in an email, adjust permissions, view an audit log, and enable inline editing for the report. You can also sort the
data in the report or view it dierently using rollups or slicing. Buons on the tab’s Data Set group give you access to the
report’s tables, lters, variables, and columns.

Group/Buon Description

Views This buon lets you choose whether to view the report using the report, layout, design, or data set
view. See Overview of Report Designer Views.

Layouts The buons in this group let you select a style and layout for the report.

Report Layouts Click this buon to load a predened report layout. The available layouts are Grid Report, Standard
Report, Chart, and Standard Report with Chart. When you select a layout, the report sections needed
for the type of report you select are automatically displayed. See Apply a Layout to a Dashboard or
Apply a Layout to an Output Level.

Tabular Click this buon to edit the report in a tabular layout. This is the default layout used when creating a
report. See Display Data Using Record or Tabular Layouts.

Record Click this buon to edit the report in a record layout. See Display Data Using Record or Tabular Layouts.

Properties The buons in this group let you modify properties that apply to the entire report.

Options Click this buon to select how the time zone used in the report is determined, who the owner of
the report is, set Auto Refresh and other options, and add notes to the report. See Change Report
Properties.

Denition
 

Click this buon and select View to view the report denition, showing descriptions of the report’s
tables, columns, lters, and other information describing the report’s structure. See View a Report
Denition.
 
Click this buon and select Export to export the denition to a le which you can import into another
interface to copy the report. See Export a Report Denition to an XML File.
 

Records Click this buon to select the record commands buons you want to display on the report’s Home tab.
See Change Record Command Actions.

Scheduling
 

Click this buon to schedule the report to be sent to other individuals. See How You Schedule Reports.
 
This buon appears only when scheduled reports are enabled. For information about enabling
scheduled reports, contact your Oracle account manager.
 

Permissions Click this buon to dene which proles should have access to run and edit the report. See Set Report
Permissions.

Audit Log Click this buon to open the audit log for the report, which shows you when the report was created,
 edited, run, and published, and which sta members performed these actions. See View a Report Audit
Log.
 
The Expanded Report Audit Log is also available. This shows you when reports and dashboards have
been generated, printed, exported, and previewed over the previous 30 days. See View the Expanded
Report Audit Log.
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Group/Buon Description

References
 

Click this buon to access pre-dened reports that show you the workspaces, navigation sets,
 dashboards, and report links that use the report you are editing. Viewing these items before editing a
report ensures that you’re aware of other items that might be impacted by changes you make. If you
decide the impact would be too great, you can create a copy of the report and edit the copy instead.
 
If you have the Analytics Administrator prole permission, you can access versions of these reports
that include search options in the Report Management component. See How to Monitor Report Usage.
 

Inline Editing
 

Click this buon to select options for inline editing, which allows sta members to edit data directly
from a report. See Enable Inline Editing.
 
This buon does not display if the sta member’s prole lacks inline editing permission.
 

Analyze The buons in this group let you sort the data shown on the report and apply rollups and slicing to the
data.

Sort Click this buon to open the Sort window and select which output columns to sort by and the sort
method. See How You Change Report Sort Order.

Rollups Click this buon to select rollup options and open the Rollups window. See Dene Rollups.

Slice Click this buon to slice the data in the report. Slicing lets you group tabular data that shares common
values in elds included in the report. See How You Slice Report Data.

Data Dictionary Click this buon to hide or display the data dictionary at the boom of the report designer. You can
select elds from the database to use in the report from the data dictionary. See Overview of the Data
Dictionary.

Data Set The buons in this group let you add or edit columns, tables, lters, variables, and edit comparison
date osets.

Tables Click this buon to view the tables used in the report, change the joins used between the tables, add
and delete tables from the report, and add join lters. See Overview of Table Relationships in Reports.

Filters Click this buon to view, add, edit, or delete report lters. See Create a Fixed or Runtime Selectable
Filter.

Variables Click this buon to view, add, edit, or delete variables. See Variables.

Analyze Click this buon to preview the report’s database query. See How to Review Report Performance.

Add Filter Click this buon to add a report lter. See Create a Fixed or Runtime Selectable Filter.

Add Variable Click this buon to add a variable to the report. See Variables.

Comparison Click this buon to add comparison date osets for comparison columns. See Add a Comparison Value
Column to a Report.

Add Column Click this buon to add a column to the report. See Add a Column to a Report.
You can also add columns by dragging them from the data dictionary onto the design surface.
 

Report Designer Display Tab  
The Display tab on the report designer ribbon provides several ways to view a report.

The Display tab is similar to the Display tab available when viewing a report. Each gives you options to apply report
styles, add report sections, page the report, x column headers, and display data using cross tabs. The report designer’s
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Display tab also includes a Show/Hide group that lets you add rulers, lines, and headings to help you identify sections
and elds shown on the design surface.

For descriptions of the buons on the tab’s Format, Sections, and Options groups, see Report Display Tab.

Buon Description

Show Rulers Click this buon to display horizontal and vertical rulers when designing the report to provide a
perspective on the report’s size.

Show Rule Lines Click this buon to display horizontal lines separating the report sections displayed on the design
surface.

Show Field Outlines Click this buon to display borders around the elds you add to the report.

Show Section Headers Click this buon to display a heading above each report section.

Show Grid Click this buon to display a grid in the report’s header and footer sections to help you align items you
add to the sections. You can also select the grid size you want to use.

Report Designer Insert Tab  
The Insert tab allows you to add columns, charts, and data exceptions to your report.

You can also add standard text elds or custom text elds created from the Text Fields explorer and images added in the
Images explorer. See Create a Text Field and Images Explorer.

Group/Buon Description

Column Click this buon to open the Column Denition window to add a column to the report. See Add a
Column to a Report.
You can also add columns by dragging them from the data dictionary onto the design surface.
 

Text Click this buon to insert a text eld into a report section that accepts text elds. See Add a Text Field
to a Header or Footer.

Image Click this buon to add an image to your report. See Add an Image to a Report Section.

Chart The buons in this group let you select a chart to add to the Charts section of your report. You can
select dierent chart types and subtypes. See How to Add and Edit Charts.

Exception Click this buon to add data exceptions to the report. See Create a Data Exception.

Report Designer Level Tab  
The report designer’s Level tab gives you access to options you can apply to report levels.

You can also create reports with drill-down levels from this tab. If your report already has multiple output levels, you can
select the level you want to edit from the Level drop-down menu located on the design surface.

You can apply level lters and group lters from this tab and add custom scripts to the report level you’re viewing. You
can also click Edit to add output descriptions to the report level.
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Group/Buon Description

Current Level The buons in this group let you edit the report level that is currently selected on the Level drop-down
menu at the top of the design surface. You can also delete the selected level, or add custom scripts or
drill-down levels to the level.

Edit Click this buon to open the Level Seings window where you can congure all level options for the
selected level. See Overview of Report Output Levels.

Delete
 

Click this buon to delete the selected level. This option is not available for the top level of a report.
 
When you delete a level, all the columns and other items added to the level are also deleted.
 

Add Drilldown Click this buon to add a drill-down level to the selected level. See Overview of Report Output Levels.

Custom Scripts Click this buon to add a custom script to the selected level. See Create a Custom Script in a Report.

Drilldown Seings The options in this group let you select the drill-down lter and link for the level. See Congure
Recursive Drill-Down Levels.

Drilldown Filter Click this drop-down menu to select the output column or columns to use as the lter for the new level.
The drill-down lter determines the data set displayed in the drill-down level.

Drilldown Link
 

Click this drop-down menu to select the output column you click to open the drill-down level. You can
also select Entire Row to open the drill-down level by clicking anywhere on a row in the parent output
level.
 
If you want to drill down into another report level instead of opening a specic record when a
value from the record is double-clicked on a report, select Entire Row as the drill-down link. When
conguring record commands for the report, select None from the Default Record drop-down menu.
See Change Record Command Actions.
 

Open in Window Click this drop-down menu to specify how you want to open the drill-down output level. To replace the
current output level, select None. To open the output level in a new window, select the location on the
screen where you want the window to open by default. You can choose Top, Boom, Left, or Right.

Grouping The buons in this group let you congure result grouping for the drill-down level.

Group Results Select this check box to group data on the selected level. See Group Data in an Output Level.

Change Group Order Click this buon to change the order of the grouped output columns. See Change Data Grouping Order.

Parameters The buons in this group let you manage level and group lters, and add record limits to the selected
level.

Level Filters Click this buon to view, add, edit, or delete level lters. See Create a Level Filter.

Group Filters Click this buon to view, add, edit, or delete group lters. See Create a Group Filter.

Add Level Filter Click this buon to add a level lter. See Create a Level Filter.

Add Group Filter Click this buon to add a group lter. See Create a Group Filter.

Record Limit Click this buon to limit the number of records that can be returned on the selected level. See Set
Record Row Limits and Page Breaks.

Report Designer Page Setup Tab  
The buons on the Page Setup tab let you change printing options for the report. You can also change the report’s
background, margins, and width.
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Group/Buon Description

Print
 

The buons in this group let you congure the report for printing and add the Page Header and Page
Footer sections. See Print a Report.
 
This buon group displays only if your prole includes the Print/Export/Forward Reports permission.
See Analytics Permissions.
 

Print Margin Click this buon to select the size of the margins used when printing the report. Options include
Normal, Narrow, Medium, and Wide.

Size Click this buon to select the size of the paper used when printing the report. Options include Leer,
 Legal, Executive, A3, A4, and A5.

Portrait/Landscape Click these buons to print the report in portrait or landscape mode.

Page Header/Page Footer Select these check boxes to include a page header and page footer when printing the report.

Print to Fit Select this check box to scale the report to your printer’s default page width and send the report to the
printer.

Background The buons in this group let you add a background color to the report. You can select the background
color and add a gradient color to blend into the primary color. You can also choose how intense the
colors should be with the Transparency seing.

Display The buons in this group let you add margins to the report and set the report’s width.

Margin Click this buon to select the width of the margins around the report. Options include None, Narrow,
 Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels for the top,
 boom, left, and right margins.

Width
 

Click this buon to select the width of the entire report. Options include Best Fit and Fit to Window.
 
When using Best Fit, all content in the report is examined to calculate column width before the report
displays. To reduce the report load time, you can enable Improve Display Performance. See Change
Data Display Options.
 

Report Designer Design Tab  
Use the Design tab to congure and add columns and data types to your custom report.

The report designer’s Design tab is available when you click a column, text eld, exception, or chart. This tab also
displays when you select a lter, variable, or table when using the data set view.

Note:  The Design tab is renamed to Text Field when a text eld is selected.

Dierent buons are shown on the tab depending on the item you select. For example, when working with a column,
buons are available to add calculations, congure data rollups, and add comparison values. When working with text
elds, you can change fonts, margins, and borders.

The options you can select for columns, text elds, data exceptions, charts, tables, and lters or variables are described
in the following tables.

Note:  The groups and buons available on this tab depend on the type of object you select. In addition, when
editing a column, the options on the tab depend on the type of data the column returns.
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Group/Buon Description

Edit Click this buon to open the Column Denition window, from which you can edit the column’s
denition. See Change Trend Options.

Arrange The buons in this group let you hide, remove, and order the position of the selected column.

Hide
 

Click this buon to hide the selected column.
 
To show hidden columns, right-click the header for a visible column, select Insert Hidden Column, and
select the column you want to show. The column will be displayed in the column’s default location.
 

Move Left/Move Right Click these buons to move the selected column one column to the left or right.

Delete Click this buon to remove the selected item from the report.

Insert Before/Insert After Click these buons to open the Column Denition window, from which you can create a new column
inserted before or after the selected column.

Sort
 

Click this buon and select Sort Ascending or Sort Descending to sort the data in the report by the
values in the selected column. See How You Change Report Sort Order.
 
Columns with a text area data type cannot be sorted.
 

Calculations The buons in this group let you add calculations to the selected column. You can hover over each
buon to view a description of the calculation. You can also choose to show multiple calculations on a
single row or on separate rows. See Add Calculations to a Report Column.

Calculation buons Click the buon for the calculation that you want to add to the selected column.

Options Click this buon and select Display Calculations on Single Row to show all the selected calculations on
one row beneath the column. Select Display Calculations on Separate Rows to show each calculation on
a separate row below the column.

Report Linking Click this buon to add, edit, and remove links to other reports. You can add conditional or
unconditional links to columns. See Overview of Linked Reports.

Rollup The buons in this group let you group the information in the report by the selected column. You can
also change the ordering if your report has multiple rolled-up columns. See Dene Rollups.

Rollup Click this buon to roll up the report’s data by the selected column. Click the buon again to remove
the rollup.

Move Up/Move Down If your report’s data is rolled up by more than one column, click these buons to move the selected
column up or down one rollup level.

Options
 

Click this buon to select rollup options. Available options include:
 

• Display Group Counts

• Display Rollup Headings

• Display Column Headings

• Repeat Column Headings

Insert Column Click this buon in the Computed group to add a computed column to the report. The types of
computed columns available depend on the values in the selected column. You can also add computed
columns from the data dictionary. See Computed Fields for information about computed columns.

Trend Options The buons in this group let you edit trend options for the selected trend column. See Change Trend
Options.
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Group/Buon Description

Perform Forecast Select this check box to enable forecasting in the trend value column.

Forecast Units Enter the number of time units to forecast forward. For example, if the trended column groups data by
week, trending forward three units displays data trended three weeks in the future.

% Change The buons in this group let you edit comparison percentage and trend percentage column options for
the selected comparison percentage or trend percentage column. See Add a Comparison Percentage
Column to a Report and Add a Trend Percentage Column to a Report.

Comparison Direction Click this buon and select how the percentage value shown in the comparison or trend percentage
column should be derived. The value can be derived from the dierence between the value in the
original column being compared/trended versus the value in the comparison or trend column. The
value can also be derived from the dierence between the value in the comparison or trend column
versus the value in the original column being compared/trended.

Show Icon Select this check box to display icons next to the percentage values returned in the column. The icons
indicate whether there is a positive change, negative change, or no change.

Icon Colors Click this buon to change the colors used for the icons to indicate a positive change, negative change,
 or no change.

Group/Buon Description

Edit Click this buon to open the Edit Text Field window, from which you can edit the selected text eld. See
Create a Text Field.

Arrange The buons in this group let you position the selected text eld on the design surface.

Anchor Click this buon to dene an anchor style for the text eld. Anchor styles determine how a text eld
moves in relation to the borders of the report section. See Specify an Anchor Style for a Text Field.

Bring to Front/Send to Back Click these buons to place the selected item on top of or beneath overlapping items.

Size to Fit Click this buon to automatically shrink or expand the element containing the text eld to t the
selected item.
Manually resizing the selected element disables this option.
 

Font The buons in this group let you change the selected text eld’s font style, size, and color. You can also
select font aributes, such as bold and italic, and change the text’s alignment within the text eld. In
addition, you can add a background color for the text eld.

Margin
 

Click this buon to select the width of the margins around the item. Available options include:
 

• None

• Narrow

• Medium

• Wide

• Custom

Selecting Custom lets you specify the number of pixels for the top, boom, left, and right margins.

Border The buons in this group let you add borders to the text eld and change the borders’ display options.
You can identify which borders you want and choose the borders’ color, size, and style.
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Group/Buon Description

Edit Click this buon to open the Exception Editor, from which you can edit the selected data exception. See
Create a Data Exception.

Display Reference The drop-down menu in this group lets you select the eld you want to highlight to indicate which rows
meet the selected data exception.

Arrange The buons in this group let you add, remove, and position the selected data exception.

Add Click this buon to add a new data exception. See Create a Data Exception.

Delete Click this buon to remove the selected exception from the report.

Move Up/Move Down Click these buons to move the selected exception up or down in the list of exceptions. See Order Data
Exceptions.

Insert Before/ Insert After Click these buons to add a new data exception before or after the selected exception. See Order Data
Exceptions.

Tabular Display The options in this group let you congure the tabular display for the selected data exception. See
Create a Data Exception.

Show Notications Click this buon to show the selected exception at the boom of the report’s tabular data.

Show Criteria Select this check box to display the exception criteria. For example, if the data exception marks
opportunities that are still active, the criteria would display opportunities.status_id = Active.

% Meeting Criteria Select this check box to show the percentage of data in the report that meets the specied exception
criteria. This information displays at the boom of the report in the Data Exceptions report section.

% Not Meeting Criteria Select this check box to show the percentage of data in the report that does not meet the specied
exception criteria. This information displays at the boom of the report in the Data Exceptions report
section.

Graphical Display The options in this group let you congure the graphical display for the selected data exception. See
Order Data Exceptions.

Show Notications Click this buon to show the selected exception in charts shown on the same report output level as the
data exception.

Show Criteria Select this check box to display the exception criteria in the chart. For example, if the data exception
marks opportunities that are still active, the criteria would display opportunities.status_id = Active.

% Meeting Criteria

% Not Meeting Criteria

Select these check boxes to display data on the chart showing the percentage of data that meets or
that does not meet the specied exception criteria.

Color Click this buon to select a color to use for the indicator on the chart that shows the amount of data
meeting the exception criteria.

Group/Buon Description

Dene Data Source Click this buon to open the Chart Wizard where you can select data options for your chart. See Add or
Edit a Chart with the Chart Wizard.

Arrange The buons in this group let you position the selected chart on the design surface and remove it from
the report.

Delete Click this buon to remove the selected chart from the report.
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Group/Buon Description

Bring to Front/Send to Back Click these buons to place the selected chart on top of or beneath overlapping charts.

Type Click this buon to change the type and subtype of the selected report. If the data options in the new
chart type dier from those in the old chart type, the Chart Wizard opens, allowing you to select new
data options. See Add or Edit a Chart with the Chart Wizard for descriptions of the available chart
types.

Chart Style Click this buon to select a chart style for the selected chart. See Chart Styles Explorer.

Labels Click in the text elds in this group to type text for the chart’s title, category, and value labels.

3D Seings Click the buons in this group to specify angle and depth seings for a three-dimensional chart. See
Chart Styles Explorer.
The buons in this group are active only if a three-dimensional chart is selected.
 

Seings Click the buons in this group to modify seings specic to charts that include bars, lines, or gauges.
See Chart Styles Explorer.
The buons in this group are active only if a chart with bar, line, or gauge properties is selected.
 

Colors Click the buon in this group to select a color scheme for the chart. See Chart Styles Explorer.

Group/Buon Description

Tables Click this buon to open the Data Set window, where you can edit the tables used in the report. See
Overview of Table Relationships in Reports.

Outer Join

Inner Join

Click these buons to join the selected table with the parent table using an outer or an inner join. See
Overview of Table Joins.

Join Condition Menu Select the elds used to link the selected table with the parent table from this drop-down menu.

Group/Buon Description

Edit The buons in this group let you modify lter properties and the logical expression combining lters.

Edit Click this buon to open the Edit Filter window, from which you can edit the lter’s properties. See
Overview of Report Filters.

Logical Expression Click this buon to open the Edit Logical Expression window, where you can modify the logical
expression combining the report lters, level lters, or group lters. The type of lter you select
determines which logical expression you can edit. See Edit a Logical Expression.

Arrange The buons in this group let you add, remove, and order lters and variables.

Add Click this buon to open the Add Filter or Add Variable window to add a new lter or variable. See
Overview of Report Filters and Add Report Variables. The type of lter you select determines whether
you add a report, level, or group lter.

Delete Click this buon to remove the selected item from the report.

Move Up/Move Down
 

Click these buons to move the selected runtime selectable lter or variable up or down in the list of
lters or variables on the data set view.
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Group/Buon Description

Moving lters and variables can help you organize them for easier management when using the data
set view. However, their positions do not change their placement on the Search window or the lters’
logical expression.
 

Insert Before/ Insert After Click these buons to open the Add Filter window to add a new lter or variable before or after the
selected lter or variable.

Filter/Variable Options The check boxes in this group let you modify options for the selected lter or variable.

Display in Docked Filters Select this check box to display the selected variable or runtime selectable lter on the docked lters
section of the report. See Add Variables or Runtime Filters to Docked Filters.

Display in Search Criteria Select this check box to include descriptions of the selected variable or lter in the search criteria
description. See Overview of Search Criteria Descriptions.

runtime Selectable Select this check box to make the selected lter available on the Search window when the report is run.
See Create a Fixed or Runtime Selectable Filter.

Required Select this check box to make the selected runtime selectable lter required. Sta members must
specify values for required lters when they run the report.

Report Designer Layout Tab  
The report designer’s Layout tab is available when you click a chart.

The buons on this tab let you apply chart style options to individual charts in your report. This allows you to create a
custom look for a chart without creating or modifying a chart style. This tab is identical to the Layout tab on the Chart
Styles designer. See Chart Styles Explorer for information about options available on this tab.

Report Designer Format Tab  
The report designer Format tab provides access to general display options, such as fonts, margins, borders, and width.

The report designer’s Format tab is available when you click a column, data exception, or chart. Some buons on the
tab vary depending on the type of item you select. For example, when working with a column, you can apply conditional
formaing to ag data in the column that meets certain criteria.

Group/Buon Description

Font
 

The buons in this group let you change the font style, size, and color. You can also select font
aributes, such as bold and italic, and change the text’s alignment. In addition, you can also add a
background color.
 
This group does not display when editing a chart.
 

Margin
 

Click this buon to select the width of the margins around the selected column. Options include None,
 Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels for the
top, boom, left, and right margins.
 
This buon displays when editing a column.
 

Border
 

The buons in this group let you add borders to the column and change the borders’ display options.
You can identify which borders you want and choose the borders’ color, size, and style.
 
This group does not display when editing a chart.
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Group/Buon Description

 

Display
 

The buons in this group let you apply conditional formaing to the column, change the column’s
width, freeze the column, and hide repeating values in the column. You can also select other display
options for the column.
 
This group displays when editing a column.
 

Conditional Formaing Click this buon to apply conditional formaing to the column’s data.

Width Click this buon to select a width for the column. Select Best Fit to automatically set the width based
on the amount of space needed to display the column’s contents. Best Fit also takes into account the
width needed by other columns in the report. Select Percentage to specify a percentage of the total
report width for the column.

Freeze Column
 

Click this buon to x the selected column in place so it does not move when you horizontally scroll the
report. This can be helpful if you want to continue to view the rst column in the report while scrolling
the report to see the columns on the right of the report.
 
When you x a column, all columns to the left of the column are also xed. You can still scroll the
columns to the right of the xed column.
 

Hide Repeating
 

Click this buon to hide consecutive repeating values in the column. For example, if the name of a sta
member is shown in the column in ve consecutive rows, you can hide repeating values to show the
name in only the rst column.
 
You can also hide repeating values on the Column Format window. This window has an option to
exclude hidden repeating values from consideration in column calculations and column auto-lter
options. When you hide repeating values from the ribbon, they are still included in column calculations
and auto-ltering.
 

Options Click this buon to select display options for the column.

Number
 

The options in this group let you display numeric values as a gauge and select numeric formats.
 
This group displays when selecting a column containing numeric values.
 

Date
 

The options in this group let you select a date format for the column and view the format.
 
This group displays when selecting a column containing date/time data.
 

Image
 

The options in this group let you congure the image used to indicate columns that meet data
exception criteria. These options are also available when creating data exceptions. See Create a Data
Exception.
 
This group displays when editing a data exception.
 

Current Selection
 

The options in this group let you select the area of the chart you want to edit and reset the style
options.
 
This group displays when editing a chart.
 

Area Menu Select the area of the chart you want to edit from this drop-down menu. You can also select the area by
clicking it on the chart on the design surface.
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Reset to Match Style Click this buon to reset customized display and formaing of the selected chart area to match the
default seings specied in the chart style that is applied to the chart.

Format
 

The buons in this group let you select border, background, and font characteristics for the selected
chart area. These same options are available when creating chart styles. See Create or Edit a Chart
Style.
 
This group displays when editing a chart.
 

Related Topics
• How You Edit Column Formaing

Report Designer Options Tab  
Use the Options tab on the report designer to change how your custom report looks.

The Options tab is available when you click a report section, column, table, or other item. The tab displays options
appropriate for the report item you have selected. The type of item you select is displayed above the Options tab. For
example, after selecting a report section you could edit the section’s margins, borders, ll colors, and layout options
from the tab.

Group/Buon Description

Margin Click this buon to select the width of the margins around the item. Options include None, Narrow,
 Medium, and Custom. Selecting Custom lets you specify the number of pixels for the top, boom, left,
 and right margins.

Border The buons in this group let you add borders to the selected item and change the borders’ display
options. You can identify which borders you want and choose the borders’ color, size, and style.

Fill The buons in this group let you add a background color to the selected item. You can select the
background color and add a gradient color to blend into the primary color. You can also choose how
intense the colors should be with the Transparency seing.

Layout
 

The buons in this group let you dene how the content of the selected report section should be
arranged and how the height of the section should be managed. See Change the Display of a Report
Section.
 
This group is not shown when a column is selected.
 

Manual Click this buon to manually size the report section and manually position text elds and images you
add to the section. When a section is congured with manual layout, you control the placement of
items on the section and the section’s height.

Automatic Click this buon to automatically size the report section and automatically position text elds and
images you add to the section. When a section is congured with automatic layout, you do not need to
specify the placement of items on the section or the section’s height.

Layouts
 

Click the down arrow on this buon to select a layout for the chart section. See Add a Chart Using
Chart Layouts.
 
This buon is shown when a chart is selected on the report.
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Auto Height If Automatic layout is selected, you can click this buon to prevent the height of the section from being
automatically set.

Table Layout If Automatic layout is selected, you can click this buon to congure the layout of the table that
underlies each report section. For example, you can specify that all columns in the table have the same
width, giving any images or text elds in those columns the same amount of horizontal space. See
Change the Layout of a Report Section.

Add Text Field
 

Click this buon to add a new text eld to the report.
 
This buon is shown when a text eld, image, or report section is selected on the report.
 

Add Chart
 

Click this buon to add a new chart to the report.
 
This buon is shown when a chart is selected on the report.
 

Add Column
 

Click this buon to add a new output column to the report.
 
This buon is shown when a column is selected on the report.
 

Report Design Surface  
The design surface displays all of the sections you add to your custom report from the report designer ribbon.

Only report sections displayed on the design surface are included in a report when it runs. After you add a section to
the design surface, you can add, edit, and remove content in the section or modify the display of the section itself. For
example, you can drag database elds to the data area, insert charts into the Charts section, and edit the report’s title
in the report header. When working on the report designer, you can add rulers, lines, and headings to help you identify
sections and elds shown on the design surface. These options are accessed from the Show/Hide group on the Display
tab.

Overview of the Data Dictionary  
You can use the data dictionary to access all the tables in the database and view details about each tables’ columns.

The data dictionary is shown on the report designer when you use the design or data set views, and lists the standard
tables and elds from the database that can be used in custom reports. Functions, variables, computed elds, and tables
created for custom objects can also be selected from the data dictionary. Any item listed in the data dictionary can be
dragged to the Data Area section to add the eld as an output column, dragged to Docked Filters to create a lter based
o the eld, or dragged to the Data Exceptions section to create an exception based on the eld.

You can view detailed information about the tables and elds shown in the data dictionary and customize the data
dictionary to show only the elds and tables you regularly use. You can also reposition the data dictionary if you want a
dierent location for it.

View Database Information on the Report Designer  
Before you add database elds to a report from the data dictionary, you may need to view information about the eld’s
contents.

When you create or edit a report, the data dictionary shown on the report designer gives you access to information
about the tables and elds in the database.
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Tip:  If you want access to the data dictionary without opening the report designer, you can also open it from 
Conguration > Database > Data Dictionary .

1. Open a report on the report designer.
2. To view a brief description of a table or eld, hover over the name of the object in the data dictionary.
3. To view a detailed description of a table or eld, right-click the name of the object in the data dictionary and

select View Data Denition.
4. To view the entire data dictionary that describes all the standard tables and elds in the database, right-click

any table name and select View Full Data Dictionary.
The data dictionary opens in a separate window.

Customize the Data Dictionary  
You can hide available tables and elds in the data dictionary that you do not use in your reports.

This is helpful if you use only certain tables and elds in your reports and want to simplify the data dictionary to make it
easier to select the tables and elds you use.

Note:  Tables and elds created for custom objects can be viewed only in the All Tables list in the report
designer’s data dictionary. This prevents customizing the data dictionary to display only custom object tables.
See Overview of Custom Objects.

1. Click Customize at the top of the data dictionary.
The Customize Data Dictionary window opens.

2. Expand the modules, tables, and elds that you want to see.
3. Clear the check boxes for those tables, elds, or modules, such as Feedback or Sales, that you do not want to

see in the data dictionary.
4. To group the database tables by the module they are most frequently used with, select the Show Modules

check box.
5. To sort the lists of tables displayed in the data dictionary by their database names instead of the tables’ aliases,

select the Sort by System Name check box.
6. Click OK.

Move the Data Dictionary  
By default, the data dictionary is located at the boom of the report or dashboard designer, but you can reposition it on
the content pane.

The following procedure is the same as that used to move the report explorer on the dashboard designer.
1. Click the data dictionary’s title bar and drag it.

When you drag the data dictionary, positioning images appear. Hovering over the various images highlights
portions of the report designer.

2. Drop the data dictionary when the section where you want it is highlighted.

The designer displays the data dictionary in the new location.

Since the location of the data dictionary is stored in your personal seings, it stays where you placed it until you move it
again.

Related Topics
• Overview of Dashboards
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Overview of Report Sections  
Every report consists of items added to the report and congured using the ribbon, design surface, and data dictionary.

Reports can have one or more output levels that contain report sections, and each section can contain text elds,
images, charts, and output columns. The data shown in charts and output columns in each output level is impacted by
the lters, variables, and comparison date osets you add to the report.

• Output levels—Each report has at least one output level, and each output level contains one or more report
sections and can have unique lters, variables, and comparison date osets. If your report has drill-down
levels, a separate output level is added for each drill-down level. The output level you’re currently viewing on
the design surface is shown in the Level drop-down menu at the top of the design surface. If your report has
multiple output levels, you select the level you want to view from the drop-down menu. See Drilling Down in
Reports and Overview of Report Output Levels.

• Output columns—The output columns you add to the report levels’ data sections determine the information
your sta members can see about the records returned in the report. There are dierent types of output
columns, including database elds, functions, and computed elds. You can apply formaing to the columns
in your report and also add calculations to tally data shown in each column. Columns can be added from the
Column Denition window or by dragging elds from the data dictionary. See Overview of Report Output
Columns.

• Charts—Charts oer a graphical display of the data returned in your report. You can add multiple charts to the
charts report section in each output level. Dierent types of charts are available so you can present the data in
dierent ways, and you can modify the display for each chart, selecting dierent colors, fonts, scales, and other
aributes. See How to Add and Edit Charts.

• Text elds and images—You can add text elds and images to your report to enhance the report’s appearance
and to clarify the report’s purpose. See Add an Image to a Report Section.

• Data exceptions—Data exceptions let you highlight data displayed in charts and output columns that meet
certain requirements. Each output level can have multiple exceptions to highlight data for dierent reasons. For
example, in an incidents report, you could display unresolved incidents in red text and overdue incidents in bold
text. The exceptions’ criteria and percentage of data meeting or not meeting the exceptions can be shown in
the report level’s charts and exceptions report section. See Create a Data Exception.

Tip:  If you want to highlight data in a single column, you can apply conditional formaing to the
column instead of using data exceptions. See How You Edit Column Formaing.

• Report output level content—Each output level on a report can have dierent headers, footers, descriptions,
charts, data exceptions, and tabular data. See Overview of Content on Report Output Levels.

• Search parameters—You can add search parameters to your report to dene the data shown in the report’s
columns, charts, and exceptions. See Overview of Search Parameters.

Overview of Content on Report Output Levels  
Each output level of a report can have dierent content. This includes docked lters, headers, footers, descriptions,
charts, tabular data, and data exceptions.

Some areas of report output levels contain text elds, such as the report’s title, and others are designed to display non-
tabular data, such as charts. The contetn you should include in each output level is primarily determined by the report’s
audience and the output level’s purpose. For example, a custom report that only you will use may not need a report
header, report footer, or similar report sections that clarify the report’s purpose and make it more presentable. However,
these are useful if the report will be sent to other sta members. If you add an area to an output level that does not have
content in it, that part of the output level does not display when the report is run.
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Note:  When creating a report, you can select a layout to have the appropriate output level areas automatically
included in the report. See Display Data Using Record or Tabular Layouts.

Report Section Description

Docked Filters
 

This is used to display runtime selectable lters at the top of the report for easy changes to the report’s
search parameters.
 
This is added to or removed from the design surface by selecting or clearing the Docked Filters check
box on the Display tab.
 

Page Header
 

This is displayed only on printed reports. By default, the page header contains the Current Date text
eld, which is a variable that outputs the date when the report is run.
 
This is added to or removed from the design surface by selecting or clearing the Page Header check
box on the ribbon’s Page Setup tab.
 

Report Header
 

This contains text elds that display at the top of each page of the report. By default, the report header
contains the Title and Sub Title text elds.
 
This is added to or removed from the design surface by selecting or clearing the Report Header check
box on the Display tab.
 

Output Descriptions
 

This contains text that you can modify to provide general information about the report. Output
descriptions can display inline, as text on a separate tab, or by rolling over the columns in the report.
See Display Output Descriptions.
 
This is shown on the design surface by selecting Display Descriptions Inline from the Output
Descriptions buon on the ribbon’s Display tab.
 

Search Criteria Descriptions
 

This contains text explaining the lters that are added to the report. Search criteria descriptions can be
displayed inline or as text on a separate tab in the report. See Overview of Search Criteria Descriptions.
 
This is shown on the design surface by selecting Display Search Criteria Inline from the Search Criteria
buon on the ribbon’s Display tab.
 

Charts
 

This contains charts that you insert into the report. Charts provide a graphic representation of data
and are most useful for quickly comparing groups of data.
 
This is added to or removed from the design surface by selecting or clearing the Charts check box on
the Display tab.
 

Data Area
 

This contains database elds you add to the report, which outputs tabular data. This is used in
almost all reports, as it provides text with specic details about specic records or specic numbers
summarizing groups of records.
 
This is removed from the design surface by selecting Do Not Display Data from the Data buon on the
Display tab.
 

Report Footer
 

The report footer is similar to the report header, though the text elds in the footer display on the
boom of each page of the report. By default, the report footer contains the Record Count text eld.
This is a variable which displays the number of records returned on the page.
 
This is added to or removed from the design surface by selecting or clearing the Report Footer check
box on the Display tab.
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Report Section Description

 

Data Exceptions
 

This contains information summarizing the data exceptions that are indicated in the data area. Data
exceptions are used to highlight specic information in the report that meets certain criteria you
dene.
 
This is added to or removed from the design surface by selecting or clearing the Exceptions check box
on the Display tab.
 

Page Footer
 

The page footer is similar to the page header section. The text elds added to this section display at
the boom of printed reports. By default, this contains the page number text eld. This is a variable
which outputs the current page number and the total number of pages in the report.
 
This is added to or removed from the design surface by selecting or clearing the Page Footer check box
on the Page Setup tab.
 

Overview of Search Parameters  
You can add search parameters to your report to dene the data shown in the report’s columns, charts, and exceptions.

Search parameters include lters, variables, and comparison date osets. These are shown on the report’s Search
window when sta members run the report, allowing them to modify the data that is returned, or you can hide lters so
their values cannot be changed by sta members.

Parameter Description

Filters Filters limit the data returned in your report by selecting a subset of information from the database.
Dierent types of lters are available, and each serves a dierent purpose.

Report Filters Report lters limit the data accessible to any of the report’s output levels and can be xed or runtime
selectable. Fixed lters cannot be changed when the report is run, but runtime selectable lters can
be changed by sta members. runtime selectable lters can also be required if you want to force sta
members to select lter values. See Create a Fixed or Runtime Selectable Filter.

Level Filters Level lters are similar to report lters and can be xed or runtime selectable. However, unlike report
lters, level lters limit the data accessible at individual output levels rather than the entire report. See
Create a Level Filter.

Group Filters Group lters can be xed or runtime selectable and are applied to data that is grouped to prevent
information about certain groups from being returned. For example, a report that shows the number
of unresolved incidents for each sta member could have a group lter to display information only for
sta members with more than ten unresolved incidents. See Create a Group Filter.

Variables Variables can be used to return dierent data, or the same data in dierent formats, in one column.
For example, you could create a single report that displays the number of incidents by sta member,
 group, queue, or status. You select the information you want when you run the report. See Variables.

Comparison Date Oset Sta members can select comparison date osets when they run a report with comparison columns.
Comparison columns are used to display related information from dierent time periods. For example,
 comparison columns can be used to see how many opportunities were created in two dierent
quarters. See Add a Comparison Percentage Column to a Report and Add a Comparison Value Column
to a Report.

Apply a Layout to an Output Level  
You can apply a predened layout to quickly modify the report’s display to make it appropriate for the report’s audience.
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For example, the Grid layout can be applied to operational reports that are used by sta members who work with
incidents, contacts, or other types of records. This layout is ideal for such reports since it does not include titles,
headers, or other report sections that are not needed when working with records. If your report is to be emailed or
printed, you could use the Standard Report layout, which includes titles, headers, and other report sections that help
explain the report’s context and purpose. The other layouts available are Standard Report with Chart and Chart
Report.

Layouts can be selected on the Geing Started window when creating reports or from the report designer’s ribbon.
Layouts selected from the Geing Started window are applied to all the output levels added to the report, and layouts
selected from the ribbon are applied to individual output levels. See Open the Report Designer for more information
about adding layouts from the Geing Started window.

1. If your report includes more than one output level, select the output level the layout should be applied to from
the Level drop-down menu at the top of the design surface.

2. Click the Home tab.
3. Click Report Layouts to open the report layouts menu.
4. Click one of the layouts to apply it to the current output level.

Layout Description

Grid Report
 

Select this layout for an output level with the Docked Filters, Page Header, Data Area,
 and Page Footer report sections.
 

Standard Report
 

Select this layout for an output level with the Docked Filters, Page Header, Report
Header, Data Area, Report Footer, and Page Footer report sections.
 

Standard Report with Chart
 

Select this layout for an output level with the Docked Filters, Page Header, Report
Header, Charts, Data Area, and Page Footer report sections.
 

Chart
 

Select this layout for an output level with the Page Header, Charts, and Page Footer
report sections. This layout is not available on the Geing Started window.
 
When a report output level includes a chart but not tabular data, you can add data for
the chart directly from the Chart Wizard. See Add or Edit a Chart with the Chart Wizard.
 

Display and Hide a Report Section  
You can choose which sections are displayed on a report.

While layouts automatically add certain report sections to the design surface, you may want to customize the sections
displayed after the layout is applied. Manually adding report sections to the design surface is simple using the ribbon.
You can add dierent sections to each output level in a report. For example, the primary output level in your report
might include a header and chart, and the other output levels in the report might include only the data area section.

1. If your report includes more than one output level, select the level you want from the Level drop-down menu at
the top of the design surface.

2. Click the Display tab.
3. Select the check box next to the section you want to display from the tab’s Section group.

The design surface changes to include the report section you select.
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4. To display the Page Header or Page Footer section when the report is printed, click the Page Setup tab and
select the Page Header or Page Footer check box on the tab’s Print group.

5. To remove a report section from the design surface, clear the section’s check box.
The design surface changes to remove the report section.

Resize a Report Section  
You can resize a report section to allow more room for images or text elds, or to reduce the size of the section to allow
more room for other sections.

1. Move your cursor over the section border that you want to move on the design surface.
The cursor changes to display directional arrows when it is over a border.

2. Drag the border to the position you want.

Change the Display of a Report Section  
Sections that are included in a report can be customized, allowing you to further tailor your report to your audience.

The available style options for each section vary. You can change the ll colors and borders of all the sections, and you
can also change the margins in the output descriptions, search criteria descriptions, data area, and data exceptions
sections.

Section styles can also be changed by applying report styles with the Auto Format feature. If the style selected using
auto format is applied after you manually modify a section style, your edits to the section style are overwrien. Editing
a section style after an auto-format style is applied overwrites the auto-format style. See Apply a Style to a Report for
more information about the Auto Format feature.

Tip:  The following procedure describes editing section styles from the Edit Style window. However, you can
also adjust style options by selecting the report section and using the buons on the Options tab.

1. Right-click the section on the design surface that you want to edit and select Edit Style.

Note:  The Edit Style window for some report sections includes an Options tab that allows you to set
layout options.

2. Click the Margins tab to modify the amount of space surrounding the contents in the section.
3. Enter the number of pixels between the text and the left, right, top, and boom margins.
4. If you’re editing a style for a report section, such as the report header, enter the number of pixels you want

between the section’s content in the Spacing eld.
5. Click the Fill tab to modify the background ll colors for the selected section.

When editing styles for report sections that do not have margins, the Fill tab is the active tab when you edit the
style.

6. Enter eld information.

Field Description

Color/Top Color/Left Color
 

The text description for this option varies depending on the gradient mode you select.
Click this box to select a primary color as the background. See Change Colors.
 

No Fill
 

Select this check box to clear any ll colors previously selected. If this box is selected,
the other options on the Fill window are disabled except for the Color option. Selecting a
color automatically clears the No Fill check box and enables the other options.
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Field Description

Gradient Mode
 

Select the positioning of the primary and secondary colors for the background from the
Gradient Mode drop-down menu. Using gradient coloring lets you merge two colors.
The following options are available.
 
None—Select this option to use only the primary color as the ll color. If you select
None, the Gradient Color eld is disabled.
 
Top to Boom—Select this option to merge the colors from the top of the background
to the boom.
 
Left to Right—Select this option to merge the colors from the left of the background to
the right.
 

Gradient Color/Boom Color/Right
Color
 

The text description for this option varies depending on the gradient mode you select.
Click this box to select a secondary color to merge with the primary color. When you
do so, the ll colors merge using the method dened in the Gradient Mode menu. See
Change Colors.
 

Transparency(%)
 

Select a percentage to dene how intense the ll colors are. A seing of 100% is
completely transparent, which prevents the ll colors from displaying. A seing of 0%
has no transparency, resulting in intense background colors. The selected percentage
is immediately reected in the Preview eld, so you can scroll through the transparency
percentages to nd a value that best suits your needs.
 

Preview
 

This area provides a sample of how the ll colors you select will appear on the report
background.
 

7. Click the Borders tab to modify the borders of a report section.
a. Enter eld information.

Field Description

Color
 

Click this box to select a color for the border. See Change Colors.
 

Style
 

Click this drop-down menu to select a border styles. Options include Solid,
Dashed, Doed, Inset, Outset, Double, Groove, Ridge, Rounded, or Separator.
The separator option lets you add empty space around the report section.
 

Weight
 

Click this drop-down menu to select the pixel size of the border. You can
choose a number between 1 and 10 pixels.
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Field Description

Preview
 

This area denes the placement of the borders you dene. Select any of the
options to place the borders, or click the area in the Preview white space
where you want the border.
 

Border buons
 

Click a buon showing a border to add or remove the selected border
aributes from the top, boom, left, or right sides of the component.
Alternatively, you can click the appropriate location in the Preview area to add
or remove borders.
 

8. Click OK.

Enable Automatic Layout of a Report Section  
Applying an automatic layout to a report section lets you quickly arrange the section’s contents for beer viewing.

When applying an automatic layout, the report section’s charts, images, and text elds are placed in an invisible table
structure, with the items placed in rows and columns. You can adjust the sizing of the rows and columns to arrange the
images and text elds exactly like you want them.

1. Add the report section you want to the report output level.
2. To add the report header or footer sections, click the Display tab and select the Report Header or Report

Footer check box.
3. To add the page header or footer sections, click the Page Setup tab and select the Page Header or Page

Footer check box.
4. Click the report section on the design surface to select it.
5. Click the Options tab and click Automatic.
6. To prevent the section’s height from being automatically adjusted to t the items you add to the section, click

Auto Height.

Tip:  When Auto Height is disabled, you can manually change the height of the section by dragging
the section’s horizontal borders up or down, just as you would if the section had a manual layout.

Change the Layout of a Report Section  
Section layout properties determine how the charts, images, and text elds you add are positioned on the section.

A manual layout lets you manually position items you add. If the section has an automatic layout, the item is positioned
automatically, and the section’s height is adjusted to best t the item. You can also set table layout options to change
how the items in the section are sized. By default, report sections have manual layout enabled.

1. Add images and text elds to the report section.
2. Click the report section on the design surface and then click the Options tab.
3. If the section has a manual layout, click Automatic to change to an automatic layout.
4. Click Table Layout.
5. To give each column in the section’s table the same amount of width, select Size All Columns Equally.
6. To give each row in the section’s table the same amount of height, select Size All Rows Equally.
7. To size each column to best show the column’s contents, select Auto Size All Columns.
8. To size each row to best show the row’s contents, select Auto Size All Rows.
9. To manually congure the table’s layout, select More Options.

10. Enter eld information.
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Field Description

Show
 

Click this drop-down menu and then select whether you want to congure rows or
columns.
 

Size Type
 

Specify how the size of the report section is determined in this section.
 

Absolute
 

Select this option to specify a certain size for the selected row or column in pixels.
 

Percentage
 

Select this option to specify a certain percentage of the total available space in the
section to allocate to the selected row or column.
 

Best Fit
 

Select this option to have the size of the selected row or column automatically adjusted
to best t the row’s or column’s contents.
 

11. Click OK.

How to Add Images, Text Fields, and Descriptions  

Add an Image to a Report Section  
When presenting a report, you may want the report to include images, such as a logo, to enhance the report’s
appearance or to customize it for your audience.

You can add images you have created in the Images explorer to the Page Header, Report Header, Report Footer, and
Page Footer sections. Images can act as backgrounds or header images in these sections. You can also use images as
links to open URLs that you specify. See Images Explorer.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Right-click the report you want to add the image to and select Edit.
4. Click the Insert tab on the report designer’s ribbon.
5. Click Image to open the list of images available in the Images explorer.
6. Click the image you want to add.

The images list closes.
7. Hover over the report section where you want to add the image.

The image name displays when the cursor is over a section that can accept an image.
8. Click to place the image in the report section you select.
9. To move an image you have added to a report section, drag the image to the position where you want to place it

in the section.

Note:  To move an image from one report section to another, both sections must have Automatic
layout enabled. See Enable Automatic Layout of a Report Section.
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10. To resize an image you have added to a report section, click the image to activate it, and then drag one of the
handles displayed on the image’s borders. The image is resized as you drag the handle.

11. To dene how the image should move in relation to the report section’s border, you can specify an anchor style
for the image. See Specify an Anchor Style for an Image.

Use a Filter or Variable in the URL Field  
You can associate a lter or variable you create in a report to open a dierent web page depending on the value selected
for the lter or variable.

When you view a report and click an image that is congured as a link, the web page the URL points to opens on the
workstation’s default browser.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Right-click the report you want to add the image to and select Edit.
4. Add an image to the report.

See Add an Image to a Report Section.
5. Create the lter or variable you will use to populate the image’s URL eld.

For example, you could create a variable named $webpages with a User Dened List type and add menu values
such as www.google.com and www.yahoo.com. See Overview of Report Filters or Variables.

6. Right-click the image on the report designer and select Edit Image Field. The Edit Image Field window opens.
7. Enter the name of the lter or variable you created in the URL eld. Surround the name in curly brackets.

For example, if the variable’s name is $webpages, enter {$webpages} in the URL eld. (Filter names do not
begin with the dollar sign.)

8. Click OK.
9. Click Save.

After you open the report, click the report’s Search buon and enter the URL you want in the lter or variable you
created. When you click the image, the web page you selected opens in your workstation’s default browser.

Associate a URL with an Image  
You can associate URLs with images to use the images as links.

When you view a report and click an image that is congured as a link, the web page the URL points to opens on the
workstation’s default browser.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Right-click the report you want to add the image to and select Edit.
4. Add an image to the report. See Add an Image to a Report Section.
5. Right-click the image and select Edit Image Field.

The Edit Image Field window opens.
6. Enter the URL you want the image to link to in the URL eld.
7. Click OK to close the window.
8. Click Save.

When you run the report and click the image, the web page the image links to opens in a web browser.

Add a Text Field to a Header or Footer  
You can add text to a report’s header and footer sections. This can be custom text you have created, or standard text
that you can modify when editing the report.

Custom text elds, created in the Text Fields explorer, and standard text elds, such as Title, can be added to the Page
Header, Report Header, Report Footer, and Page Footer report sections.
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You can also insert values from a report’s lters and variables into the text elds on the report. See Create a Text Field
for information about creating and editing custom text elds in the Text Fields explorer.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Right-click the report you want to add the text eld to and select Edit.
4. Click the Insert tab on the report designer’s ribbon.
5. Click Text Field to open the list of text elds.

The window displays standard text elds, such as Title, and custom text elds you can add using the Text
Fields explorer. The text elds’ default fonts, colors, and other aributes are reected in the display.

6. Click the text eld you want to add to the report.
The text elds list closes, and the cursor displays with a small version of the text eld when you hover over
report sections that accept text elds.

7. Click the report section where you want to add the text eld.
The text eld is added to your report.

8. To move the text eld, drag it to the position you want.

To move a text eld from one report section to another, both sections must have Automatic layout enabled. See
Enable Automatic Layout of a Report Section.

9. To resize a text eld in a report section, click the text eld to activate it and then drag one of the handles
displayed on the text eld’s borders.
The text eld is resized as you drag the handle.

10. Click Save.

Edit a Text Field in a Report  
After adding a text eld to a report section, you can edit it to change the fonts, colors, text, and other aributes.

You can have one generic text eld that can be added to several reports, which can then be modied in each report.

Note:  Certain standard text elds, such as Record Count or Rows per Page, include values that are
dynamically updated when the report is run. You can edit these elds, but you cannot edit their dynamic value
placeholders.

1. Right-click the text eld in the report section on the design surface and select Edit Text Field.

Tip:  If you know the specic options you want, it can be faster to select them from the ribbon.
Opening the window gives you an overview of all the available options.

The Edit Text Field window opens.
2. Edit the text eld on the Edit Text Field window.
3. Click OK.

Related Topics
• Create a Text Field

Display a Filter Value in a Text Field  
You can insert the values currently selected in a report’s lters and variables into text elds on the report. For example, a
text eld can display the value selected in a lter that lters on the sta member assigned to a group of incidents.
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The following procedure describes how to use a value from a lter in a text eld, but a similar process is used to display
the value from a variable.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Right-click the report you want to add the text eld to and select Edit.
4. Create a lter that includes the values you want to display in the text eld.

For example, you can add a lter to an incidents report that lters on the sta accounts that incidents are
assigned to. See Overview of Report Filters.

5. Add a text eld to your report.
See Add a Text Field to a Header or Footer.

6. Right-click the text eld and select Edit Text Field.
The Edit Text Field window opens.

7. Enter the text you want to display in the Text eld on the window’s Text tab. Enter the name of the lter with
braces around it where you want the lter value to display in the eld. {lter_name}

For example, if the report has a lter named Assigned that lters on the sta member assigned to incidents,
you can enter Assigned to {Assigned} in the window’s Text eld.

8. Click OK.
9. Click Save.

When the report runs, the text eld will display the static text entered in the eld along with the lter or variable value
that is currently selected. For example, if the lter value is currently Tina Smith, the text eld will read Assigned to Tina
Smith.

Specify an Anchor Style for an Image  
You can change the default anchor style of an image in a report so that it moves with the boom or right side of the
report section when the section’s borders are changed.

By default, when a report section is resized, images and text elds in the section maintain the same distance between
the top and left side of the report section.

1. Right-click an image on the design surface and select Edit Image Field.
See Add an Image to a Report Section.

2. Click the Anchor Style drop-down menu to display the anchor style options.
The image’s current anchor style displays when you click the drop-down menu.

3. To clear an anchor, click the gray bar indicating an active anchor.
4. To add an anchor, click the appropriate clear bar.

For example, to anchor an image to the boom and right side of the report section, clear the gray bars at the
top and left side, and click the clear bars at the boom and right side of the anchor style selection control.

5. Click OK.

Related Topics
• Specify an Anchor Style for a Text Field

Specify an Anchor Style for a Text Field  
You can change the default anchor style of a text eld in a report so that it moves with the boom or right side of the
report section when the section’s borders are changed.

By default, when a report section is resized, images and text elds in the section maintain the same distance between
the top and left side of the report section.

1. Click a text eld on the design surface to select it.
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See Add a Text Field to a Header or Footer.
2. Click Anchor on the Text Field tab to view anchor style options.

The text eld’s current anchor style displays. The gray bars that are displayed show you which sides of the
report section the text eld is anchored to.

3. To clear an anchor, click the gray bar indicating an active anchor.
4. To add an anchor, click the appropriate clear bar.

For example, to anchor a text eld to the boom and right side of the report section, clear the gray bars at the
top and left side, and click the clear bars at the boom and right side of the anchor style selection control.

Related Topics
• Specify an Anchor Style for an Image

Display Output Descriptions  
The Output Descriptions report section displays text you enter to describe output levels and columns in the output level.

The output descriptions you add can be displayed inline, on a separate tab in the report, or when rolling over the
columns in the report that have denitions dened. You can select the placement of the output descriptions from the
ribbon.

1. Click the Display tab.
2. Click Output Descriptions and select the display option you want from the list.

Option Description

Do Not Display Descriptions
 

Select this option to remove output descriptions from the report.
 

Display Descriptions on Column
Rollover
 

Select this option to show the output descriptions when rolling over the report columns
that have denitions dened.
 

Display Descriptions Inline
 

Select this option to show the output descriptions in the output level, below the page
header and report header sections.
 

Display Descriptions on Separate
Tab
 

Select this option to show the output descriptions on a separate Description tab. The tab
is automatically added to the report when you choose this option.
 

Related Topics
• Add Output Columns to a Report

• Add Text to Output Descriptions

Add Text to Output Descriptions  
You can add text to the output descriptions section of a report to help describe what the report output means.

1. Open the report you want to edit.
2. To add a description to an output level, select the output level you want from the Level drop-down menu at the

top of the design surface.
a. Click the Level tab, then click Edit to open the Level Seings window.
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b. Enter the text you want to describe the output level in the Description eld.
c. Click OK.

3. To add an output description to a column, click the column on the design surface to select it.
a. Click the Design tab.
b. Click Edit to open the Column Denition window.
c. Enter the text you want to describe the column in the Description eld.
d. Click OK.

Related Topics
• Display Output Descriptions

Overview of Search Criteria Descriptions  
Search criteria descriptions provide additional information about the data displayed in a report.

By default, the Search Criteria Descriptions report section includes information about the lters in your report, along
with descriptions of the report’s variables, record limits, and comparison date osets. However, you may not want to
display descriptions of all report components, so you can specify which descriptions you want to display. Search criteria
descriptions can be displayed inline or on a tab in the report. You select where to place the descriptions from the Search
Criteria buon on the Display tab.

Related Topics
• Add Search Criteria Descriptions

• Remove Search Criteria Descriptions

Add Search Criteria Descriptions  
You can choose whether or not you want to show search criteria descriptions on a report, and how you want the
descriptions to be displayed.

1. Click the Display tab.
2. Click Search Criteria and select what you want from the list.

Option Description

Do Not Display Search Criteria
 

Select this option to remove search criteria descriptions from the report.
 

Display Search Criteria Inline
 

Select this option to show the search criteria descriptions in the output level’s output,
 below the page header and report header text elds.
 

Display Search Criteria on Separate
Tab
 

Select this option to show the search criteria descriptions on a separate Description tab.
 

Related Topics
• Overview of Search Criteria Descriptions

• Remove Search Criteria Descriptions
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Remove Search Criteria Descriptions  
You can remove search criteria descriptions that you do not want to display in a report.

1. Click the Search Criteria Descriptions tab or its area on the design surface.
2. Click the Options tab.
3. Click Search Criteria.
4. Clear the check boxes next to the descriptions you do not want to display.
5. Click OK.

Related Topics
• Overview of Search Criteria Descriptions

• Add Search Criteria Descriptions

Overview of Report Output Columns  
The output columns you add to a report display tabular information about your data.

Output columns are added to the data area of each output level. After an output column is added to the output level,
you can move the column, change the column headers, add notes to the column, change the column’s display, and add
calculations to tally the values shown in the column. You can also create data exceptions to highlight data returned in
the columns. For example, if you want to highlight all incidents in a report that are unresolved and overdue, you could
create data exceptions to display these records in bold red text.

Output columns can be any of these.

• Fields from the database

• Functions

• Variables

• Computed elds

All of these items can be added from the ribbon or by dragging the eld from the data dictionary to the design surface.

Database Fields  
Generally, most of the columns added to reports are elds from the database, which contain the data you see
throughout Oracle Service Cloud.

Fields from tables that are created for custom objects are also available (see Overview of Custom Objects). The database
elds that can be used in reports are listed in the report designer’s data dictionary.

Tip:  To view descriptions of the tables and elds in the data dictionary, right-click the table or eld and select
View Data Denition. A new window opens with a description of the table or eld.

Related Topics
• Database Field Suxes

Database Field Suxes  
By adding a sux to a database eld, you can change the value that is returned in a report.
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When certain database elds are used in report columns, the output is automatically modied to display the data in an
easily readable format. For example, the incidents.assgn_acct_id eld stores the ID numbers of the agents who have
incidents assigned to them. Since report users generally prefer to see agent names instead of ID numbers, the names
are returned instead of the ID numbers.

However, there are occasions when you may want the report to return the agents’ ID numbers instead of their
names. In such cases, the sux .id can be added to incidents.assgn_acct_id, changing the column’s expression
to incidents.assgn_acct_id.id. This sux prevents the name associated with the record from being returned
automatically and forces the report to instead return the ID number from the database eld.

There are several suxes that can be added to name lookup elds, such as incidents.assgn_acct_id, or currency elds,
such as opportunities.mgr_value. Other types of database elds do not accept suxes. Each sux has a dierent
purpose.

Sux Description

Name lookup eld suxes
 

These suxes can be used with database elds that trigger an automatic name lookup when used in
reports.
 

.id
 

This sux prevents Analytics from performing a name lookup and returns the ID number stored in the
eld. For example, answers.assgn_acct_id.id would return the account ID number of the sta
member an answer is assigned to.
 

.desc
 

This sux can be used only with name lookup elds that have a description eld. The sux
returns the text from the eld’s description rather than the eld’s ID number or name. For example,
incidents.prod_lvl1_id.desc would return the text description of the parent product an incident
is associated with.
 

.name
 

This sux returns the name that is associated with the database eld. For example, answers.map_
cat_lvl1_id.name would return the name of the parent category an answer is associated with.
 
This sux is rarely used since the name lookup is usually performed by default.
 

Currency eld suxes
 

These suxes can be used with database elds that store currency values.
 

.curr_id
 

This sux returns the type of currency the value was stored in, rather than the currency value. For
example, opportunities.mgr_value.curr_id could return USD, GBP, or another currency type.
 

.rate_id
 

This sux returns the exchange rate that is used to calculate the eld’s currency value when returning
the value in a dierent currency format. For example, opportunities.rep_value.rate_id could
return 1.45000 or another exchange rate.
 

.native This sux returns the eld’s value in its original currency instead of the currency determined by sta
account or interface seings. For example, opportunities.mgr_value.native used in a report on
a British interface would return the manager forecast value in USD if that value was originally entered
on a U.S. interface.
 

Related Topics
• Database Fields
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Variables  
You can create variables to use in report output columns, lters, images, text elds, and data exceptions.

Using a variable in an output column lets you return dierent data, or data in dierent formats, in the same column.
For example, you could create a single report that displays the number of incidents by sta member, group, queue, or
status. You select which of the four variable values to use in the report from the Search window or from a menu at the
top of the report if the variable is docked.

Using a variable in a lter lets you combine the functionality of lters with the exibility of variables. For example,
you could create a variable that groups records together in time periods, and then create a lter with an expression of
date_format(opportunities.created, $date_group), where $date_group is the variable to lter on opportunities created
during a particular year. To use the lter, you would simply enter the year you want to report on. Without such a lter,
the report would need to include a lter using the between operator that requires entering both a start time and an end
time.

Using a variable in a data exception lets you use a single exception to ag dierent data. This eliminates the need to
create multiple exceptions to ag data in dierent columns. For example, you could use a variable in an exception to ag
incidents that were created more than one day ago or to ag incidents that were updated more than one day ago. The
information you want to ag is selected on the Search window when you run the report. See Create a Data Exception.

Using a variable in an image lets you dynamically generate links to web pages and change the displayed image when
you select dierent variable values. See Add an Image to a Report Section. Using a variable in a text eld lets you display
the variable’s current value in the text eld. See Display a Filter Value in a Text Field.

Add Report Variables  
Before you can use variables in report output columns, lters, or data exceptions, the variables rst need to be created.

There are several types of variables you can use, including predened lists, user-dened lists, ad hoc values, and
replacement values. Each of these serves a unique function.

1. Click the Home tab.
2. Click Add Variable.

The Add Variable window opens.
3. Enter a name for the variable in the Name eld.

Variable names are always preceded by the dollar sign.
The options on the Add Variable window change depending on the variable type that is selected.

4. Enter an optional prompt in the Prompt eld.
The Prompt eld is not available when using a Replacement Value variable type, as this type is not displayed
when running a report
This text displays on the Search window when running the report. If this eld is left empty, the variable’s name
is displayed instead.

5. Select the variable type from the Type drop-down menu.

Field Description

Predened List variables Select this type to use values from an existing menu or predened list in the variable.
When selecting this option, all menu elds from the tables used in the report are
available, along with three predened lists.

◦ Group Date—This list contains date/time formats, such as Month, Week, and Day
of Month.

◦ Yes/No—This list contains Yes and No options.
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Field Description

◦ Currency Formats—This list contains currency formats, such as USD and CAN, that
are dened on your site.

User Dened List
 

Select this type to compile your own list of menu items to use for the variable. For
example, if you wanted the variable to return either incidents’ statuses or assigned sta
accounts, you could create a variable value for incidents.status and another for
incidents.assgn_acct_id.
 
When you select this type, you must select a data type for the variable. See step 7 in this
procedure for a description of the available data types.
 

Ad Hoc Value
 

Select this type to allow sta members to enter their own value for the parameter at
runtime, without having to select from a list. For example, an individual using the report
types the exact expression or string to use as the variable value.
 
When you select this type, you must select a data type for the variable. See step 7 in this
procedure for a description of the available data types.
 

Replacement Value Select this type to enter an expression that you want to use in several places in the
report. The replacement value variable you create can be added to the report in any
place you would otherwise need to enter the expression. This lets you use a short
variable name rather than a lengthy expression.

6. If using a predened list variable type, select the list to use from the List Name drop-down menu.
7. If using a user-dened list or ad hoc value variable type, select the data type to use from the Data Type drop-

down menu.

Data Type Description

String
 

Select this option to add a variable that uses a string eld.
 

Integer
 

Select this option to add a variable that uses an integer eld.
 

Float
 

Select this option to add a variable that uses a numeric eld that can contain decimal
points.
 

Date and Time
 

Select this option to add a variable that uses a date and time eld.
 

Currency
 

Select this option to add a variable that uses a currency eld.
 

Expression
 

Select this option to add a variable that uses a database eld (for example,
 incidents.status).
 
This data type is not available for ad hoc values.
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Data Type Description

 

8. If using a user-dened list variable type, create the list items you want to include.
a. Click Add Item. The Edit Variable List Item window opens.
b. Enter a name for the list item in the Name eld.
c. Enter a value for the list item in the Value eld.

The format of the Value eld changes depending on the data type selected for the user-dened list. For
example, the Value eld for a Date and Time list item displays a calendar, whereas the Value eld for an
expression list item displays a text box and includes an Advanced option you can click to open the data
dictionary to help you build the expression.

d. Click OK.
e. Add the other list items you want to be able to select for the variable.

9. If using a predened list or user-dened list variable type, enter a default value for the variable in the Default
eld.

10. If using an ad hoc value variable type, enter a default value for the variable in the Default eld.
11. Do one of the following:

◦ If using a replacement variable type, enter the expression you want the variable to replace.

◦ Click Use Data Dictionary to open the data dictionary to create the expression from database elds and
functions.

12. Click OK.

Related Topics
• Variables

• How to Use Variables in Columns

How to Use Variables in Columns  
You can use variables you have created in the output columns you add to a report.

After you create a variable in a report, it is added to the variables list in the report designer’s data dictionary. You can
then create output columns that use the variable in the same manner as you would any other output column, creating
the column’s expression out of database elds, functions, computed elds, and variables listed in the data dictionary. In
some cases, the variable will be the only item in the column’s expression. In other cases, the variable will be combined
with functions or database elds to form the column’s expression.

When a predened list, user-dened list, or ad hoc value variable is included in a report’s output columns, a menu listing
the variable’s options displays on the report’s Search window. The variable menu can also display at the top of the
report in the docked lters section for easy access by individuals using the report.

Related Topics
• Add a Column to a Report

Computed Fields  
You can create computed elds and use them in your reports.

Computed elds aren’t actual elds in the database, but are calculated from the columns in your output level. Before
the output level has columns added, computed elds aren’t available. After you add columns to the output level, the
data dictionary’s Computed Fields tree includes the columns you added. If you click a column in the tree, the available
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computed elds for that column appear in computed elds in the data dictionary. You can then drag the computed eld
you want to the design surface, just as you would with a standard database eld.

Tip:  You can also add computed elds by clicking a column on the design surface to select it, clicking the
Design tab, clicking the arrow on the Insert Column buon, and selecting the computed eld you want to add.

Most database elds have only a comparison value computed eld available. Additional calculations are available for
integer elds, which store numbers. The moving average, moving total, percentage of average, percentage of total,
running average, and running total columns are all available to use in output levels and in rollups, if rollups exist in the
report. When computed elds are added to rollups, the values are reset at the beginning of each rollup section.

The Comparison Value and Comparison Percentage Value computed elds are described in Add a Comparison Value
Column to a Report. The Trend Value and Trend Percentage Value computed elds are described in Add a Trend
Percentage Column to a Report and Add a Trend Value Column to a Report.

Related Topics
• Moving Total

• Percentage of Average

• Percentage of Total

• Running Average

• Running Total

• Moving Average

• Change the Number of Data Points

Moving Average  
This column outputs a centered moving average.

Centered averages calculate the average for a value in a column by averaging that value, along with a number of values
in the column prior to and preceding that value. For example, if a report outputs the number of incidents per month, a
centered average for March that uses three data points would use the number of incidents from February, March, and
April to derive the average.

Tip:  Moving averages work best using odd numbers of data points, but can use an even number, though the
internal calculation to derive the value will dier somewhat.

For an odd number of data points, the centered average at i for a given data point, di, and number of data points, N, is:

(di-(N-1)/2 + di-(N-1)/2 +1 + ...di + ...di + (N-1)/2 -1 + di + (N-1)/2)/N.

For an even number of data points, the centered average at i for a given data point, di, and number of data points, N, is:

(di-N/2 + 2*di-N/2 +1 + ...2*di + ...2*di + N/2 -1 + di + N/2)/2N.

When you add a report moving average column to a report, the calculation automatically uses three data points.
However, the number of data points can be changed. See Change the Number of Data Points.

Related Topics
• Computed Fields
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Moving Total  
A report moving total column outputs a running total of the values in the specied column.

The totals are calculated for the current row, and a number of preceding rows determined by the number of data points
you select. By default, the report moving total calculation uses three data points. For example, if you had a column with
four rows, with values of 10, 20, 30, and 40, respectively, and used three data points, the corresponding values in the
report moving total column would be NULL, NULL, 60, and 90.

Related Topics
• Computed Fields

Change the Number of Data Points  
The report moving average and report moving total computed elds use data points in their calculations. The method
to select the number of data points to use is identical for either computed eld.

1. Add a report moving average or report moving total column to the output level.
2. Right-click the column on the design surface and select Edit Moving Calculations Options.
3. Enter the number of data points you want to use in the calculation.
4. Click OK.

Tip:  You can also change the number of data points by selecting the moving calculations column,
clicking the Design tab, and entering the number of data points in the Number of Data Points drop-
down menu.

Related Topics
• Computed Fields

Percentage of Average  
A report percentage of average column calculates the average of the values in the specied column, and then returns
the percentage of that total of the value in the current row.

For example, if you had a column with three rows whose values were 10, 20, and 30, the average of the values in the
column would be 20. The values returned in the report percentage of average column would be derived by dividing
the value in each row by the average value of the column, and multiplying the result by 100. In this example, the values
returned would be 50%, 100%, and 150%, respectively.

Related Topics
• Computed Fields

Percentage of Total  
A report percentage of total column calculates the total of the values in the specied column, and then returns the
percentage of that total of the value in the current row.

For example, if you had a column with three rows whose values were 10, 20, and 30, the total of the values in the column
would be 60. The values returned in the report percentage of total column would be derived by dividing the value in
each row by the total value of the column, and multiplying the result by 100. In this example, the values returned would
be 16.6%, 33.3%, and 50%, respectively.
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Related Topics
• Computed Fields

Running Average  
A report running average column averages the values in a specied column for all the column’s rows, up to and
including the value in the current row.

For example, if you had a column with three rows, with values of 10, 20, and 30, respectively, the corresponding values in
the report running average column would be 10, 15, and 20.

Related Topics
• Computed Fields

Running Total  
A report running total column totals the values in a specied column for all the column’s rows, up to and including the
value in the current row.

For example, if you had a column with three rows, with values of 10, 20, and 30, respectively, the corresponding values in
the report running total column would be 10, 30, and 60.

Related Topics
• Computed Fields

Functions for Reports  
Functions let you apply standard mathematical functions to the data from your database, and output the modied data
in report columns.

For example, using the count() function, you can output the number of contacts associated with an organization. The
column’s expression in this example would be count(contacts.c_id). You can also combine dierent functions and
database elds in the same column’s expression.

Note:  There is a limit of 3,500 characters in the column expression eld. You can use replacement variables to
create expressions that require more characters. See Add Report Variables.

When you drag a function from the data dictionary to the design surface, the Column Denition window opens. This
lets you enter the variables used in the function’s expression. You can either enter the variables in the Expression eld
or, if the variable is an item listed in the Available Columns/Functions eld, you can drag the item into the function’s
expression.

Function Description

Aggregate Functions
 

Select from the following to use an aggregate function in the expression.
 
Aggregate functions can be used only when dening output.
 

avg(expr) This function computes an average value for the data set expr.
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Function Description

count(expr) This function returns the number of rows included in the data set expr.
 

first(expr, sort column1[, sort
column2][,...])

This function returns the rst value of data set expr based on the order of the specied sort columns.
For example, the expression rst(threads.note, threads.entered, threads.seq) returns the rst thread
note in the data set based on time entered and thread sequence.
 

group_concat(expr, separator[,
 sort column 1, ASC|DESC][, sort
column 2, ASC|DESC][,...])

This function allows you to combine multiple values from data set expr into a delimited list in a single
row. The list is delimited by separator and ordered by the specied sort columns. For example, the
expression group_concat(threads.note, ',', threads.entered, ASC) returns a comma-
delimited list of thread notes ordered by time entered ascending.
 

last(expr, sort column1[, sort
column2][,...])

This function returns the last value of data set expr based on the order of the specied sort columns.
For example, the expression last(threads.note, threads.entered, threads.seq) returns the last thread
note in the data set based on time entered and thread sequence.
 

max(expr) This function returns the largest numerical value, the last string in alphabetical order, or the latest date
in the data set expr.
 

min(expr) This function returns the smallest numerical value, the rst string in alphabetical order, or the earliest
date in the data set expr.
 

sum(expr) This function returns the sum of the values in the data set expr.
 

sum_distinct(expr, reference) This function returns the sum of distinct values in an expression for a particular record (reference)
rather than for all records of the same type in a table. For example, if you want to calculate the
sum of all quotas for a particular sales person, you could add a function of sum_distinct(sa_
period2accts.quota, sa_period2accts.acct_id).
 

stddev(expr) This function returns the standard deviation of expr. For example, the expression
stddev(answers.solved_count) returns the standard deviation of all the values in the solved_
count column of the answers table.
 

String Functions
 

Select from the following to use a string function in the expression:
 

concat(str1, str2) This function combines input character strings from multiple expressions into a single output
string. Two or more expressions can be appended with this function. For example, the expression
concat('www.','global','.com') returns the value www.global.com.
 

instr(str, substr) This function returns the numeric position (in characters) of the initial occurrence of string substr in
string str. For example, the expression instr('globalcellphones.com','cell') returns the
value 7.
 

length(str) This function returns the length (in characters) of the string. For example, the expression
length('cell phones') returns the value 10.
 

lower(str) This function returns string str in all lowercase characters. For example, the expression
lower('Global.COM') returns the value global.com.
 

787



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Function Description

ltrim(str) This function returns the string str without leading spaces. For example, the expression ltrim('
Cell phone') returns the value Cell phone.
 

lpad(str1, X, str2) This function returns str1 padded on the left with str2 until str1 is X characters long. For example,
 the expression lpad('phone', 10, '@') returns the value @@@@@phone.
 

rpad(str1, X, str2) This function returns str1 padded on the right with str2 until str1 is X characters long. For example,
 the expression rpad('phone', 10, '@') returns the value phone@@@@@.
 

rtrim(str) This function returns the string str without trailing spaces. For example, the expression
rtrim('agarfield@global.com ') returns the value agarfield@global.com.
 

substr(str, start_pos, [length]) This function returns a portion of the string str starting at the character dened by start_pos (an
integer) and ending at the character dened by length (an integer). If length is not indicated, it
returns the remainder of the string.
 

to_char(expr) This function converts the numeric expr to a character string.
 

to_number(str) This function converts the character string str to a numeric. If the str is not numeric, this function
returns zero. If str is a combination of numbers and other characters and begins with a number, this
function returns only the initial numeric portion. For example, to_number('123ABC') returns 123.
 

upper(str) This function returns string str in all uppercase characters. For example, the expression
upper('global.COM')returns the value GLOBAL.COM.
 

Date Functions
 

Select from the following to use a date function in the expression.
 
See Reference Information for a list of the date/time format tokens you can use in date functions. Most
of the date functions allow you to combine the supported format tokens in any combination you want.
 
Date functions do not support dates earlier than January 1, 1970.
 

date_add(date, units, interval,
 round)

This function returns the value of date plus a specied amount of time where date is a date/time type
column or a literal string in the format YYYY-MM-DD or YYYY-MM-DD HH:MI:SS. The amount of time
to add is specied by units and interval. Unitsis an integer or expression referring to an integer
database eld specifying the number of intervals to add or subtract. Interval can be SECONDS,
 MINUTES, HOURS, DAYS, WEEKS (Sunday through Saturday), IWEEKS (Monday through Sunday),
 MONTHS, QUARTERS, or YEARS. To round the result to the beginning of the specied interval, set
the round argument to 1. If you set round to 0, the result will not be rounded. For example, the
expression date_add(‘2013-11-25 22:35:00’, 48, HOURS, 1) returns the value 2013-11-27
22:00:00.
 

to_date(str, format) This function converts the value entered in str that is in the format specied in format to a date or
date/time value. For example, the expression to_date(‘20140215’,’YYYYMMDD’) returns a value
of 02/15/2014.
 
Unlike other date functions, to_date supports only the following date formats.
 
DD MM YYYY HH24:MI:SS
 
DD MM YYYY HH:MI:SS AM
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DD MON YY
 
DD MON YYYY
 
DD-MM-YY
 
DD-MM-YYYY
 
DD.MM.YY
 
DD.MM.YYYY
 
DD/MM/YY
 
DD/MM/YYYY
 
DD/MM/YYYY HH:MI:SS AM
 
MM-DD-YY
 
MM-DD-YYYY
 
MM/DD/YY
 
MM/DD/YYYY
 
MON DD YY
 
MON DD YYYY
 
MON DD YYYY HH:MI AM
 
MON DD YYYY HH:MI:SS AM
 
YY.MM.DD
 
YY/MM/DD
 
YYMMDD
 
YYYY-MM-DD
 
YYYY-MM-DD HH24:MI:SS
 
YYYY-MM-DDTHHH24:MI:SS
 
YYYY.MM.DD
 
YYYY/MM/DD
 
YYYYMMDD
 

date_format(date, format) This function converts date from a date/time data type to a string and reformats it to match the
format specied by format. Date can be a date/time type column or a literal string in the format
YYYY-MM-DD or YYYY-MM-DD HH:MI:SS. For example, the expression date_format('2013-11-25
22:25:00', 'DAY, MONTH DD, YYYY, HH12:MI PM') returns the value Tuesday, November 25, 2013 10:25
PM.
 

date_diff(date, date) This function returns the number of seconds occurring between two dates. For example, the
expression date_di('2014-07-26 22:25:00', '2014-07-25 10:30:00’) returns the value 129300. Another
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example is date_di(sysdate(),incidents.updated). This expression returns the number of seconds
between the current time and the time that incidents were last updated.
 
To change the format of the output, use the time_format function. For example,
 time_format(date_di('2014-07-26 22:25:00', '2014-07-25 10:30:00’), 'HH24h MIm SSs') returns the
value 35h 55m 00s.
 

rel_date_diff(date2, date1, rr_
id)

This function returns the number of seconds between two dates, taking holidays and the work hours
specied in response requirements into account. The value for rr_id is the response requirement ID
that you want to use. We recommend using the value from the incidents.rr_id eld.
 
For example, if a site’s response requirements are congured with work hours from 9 A.M. to 5 P.M.,
 the expression rel_date_di('2014-07-26 22:25:00', '2014-07-25 10:30:00’,1) returns the value 52200.
Another example is rel_date_di(sysdate(),incidents.rel_due,incidents.rr_id). This expression returns
the number of seconds between the current time and incidents’ due dates, excluding holidays and
taking the work hours congured in the response requirements associated with the incidents into
account.
 
This function is not available for use in variables, lters, or exceptions. In addition, it cannot be nested
in other expressions.
 

date_trunc(date, units) This function truncates date to the unit specied by units, with units being a time interval of
SECONDS, MINUTES, HOURS, DAYS, WEEKS (Sunday through Saturday), IWEEKS (Monday through
Sunday), MONTHS, QUARTERS, or YEARS. For example, the expression date_trunc('2013-11-25
22:25:10', HOURS) returns the value 2013-11-25 22:00:00.
 

sysdate() This function returns the current system date in the format YYYY-MM-DD HH:MI:SS.
 

time_format (seconds, format) This function converts seconds to the specied time format. For example, the expression time_
format(86610,'HH24 MI SS') returns the value 24 03 30.
 

date_group(expr, format) This function lets you group records together according to a date range that you specify, and include
rows for date ranges that have no associated records. If you do not want to return rows for date ranges
with no records, you could use date_format instead.
 
For example, if you have incidents created in January and March, but none in February, and create a
report with the expression for column A set to date_group(incidents.created, ‘YYYY-MM’),
 and the expression for Column B set to count(*), the report would output:
 
2014-01 10
 
2014-02 0
 
2014-03 15
 
If you changed Column A’s expression to date_format(incidents.created, ‘YYYY-MM’) to use
the date_format function instead of date_group, the output would be similar, but would not include a
row for February.
 
When this function is used in a column, the report designer automatically groups the data in the
output level, and sets the output level’s group and sort order options. At least one date lter is required
to use this function.
 

Logical Functions
 

Select from the following to use a logical function in the expression.
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if(expression, then result, else
result)

This function returns the then result if the expression is true and returns the else result if the
expression is false. For example, the expression if(incident.c$field=1, ‘Yes’, ‘No’) returns
Yes for incidents where the value of c$field is 1. If the value is not 1, No is returned.
 
You can use IS NULL and IS NOT NULL as part of the expression. For example, you could use the
expression if(incident.c$field IS NOT NULL, 'Yes', 'No').
 

decode(test expression, test
value 1, result 1, [, next test
value, next result]* [,default])

This function compares test expression to each test value in order and returns result for
the rst test value that expression matches. If expression does not match any test value,
 default is returned. If default is undened, NULL is returned. The decode function can perform
table lookups, allowing you to use text strings as test values rather than requiring coded values (for
example, you can use Review as a test value for the expression faqs.status even though the table
contains code value in the status column).
 

nvl(expr1, expr2) If the value expr1 is null, this function returns the value expr2. However, if the value expr1 is not
null, then the value expr1 is returned. The value of expr2 must match the data type of expr1.
 

Math Functions
 

Select from the following to use a math function in the expression.
 

bitand(X, Y) This function returns the bitwise AND of two integers, X and Y.
 

ceiling(X) This function returns the smallest integer value greater than or equal to X.
 

oor(X)
 

This function returns the largest integer less than or equal to X.
 

power(X, Y) This function returns the value of X to the power of Y. For example, power(2,3) would return 8.
 

rand() This function generates a random number between 0 and 1. This output can be used to produce a
random sampling of data. For example, to generate a random sample of incidents, add a column
with an expression of rand() to an incidents report and sort on the column. The report will show
information for incidents meeting your search criteria, sorted randomly.
 

round(X, D) This function returns the value X rounded to the nearest number with D decimals. For example,
 round(5.55555,2) returns the value 5.56.
 

truncate(X, D) This function returns the value X truncated to the D decimal places. For example, the expression
truncate(5.55555, 2) returns the value 5.55.
 

Currency Functions
 

Select from the following to use a currency function in the expression.
 

cvt_currency(expr, str) This function converts the currency value expr to the specied currency str. For example, the
expression cvt_currency(opportunities.rep_value, 'USD') returns the rep_value in U.S.
dollars when “USD” is stored as the abbreviation for U.S. dollars in the currencies table.
 

make_currency(expr, str) This function converts an integer or decimal number to the specied currency str. For example, the
expression make_currency(100.00, 'USD') returns the expr in U.S. dollars. You can also replace
str with the value dflt to convert the expression to the user’s currency.
 

791



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Function Description

to_currency(expr, str) This function converts an integer expr to a value in str currency. The numeric value is converted to
an amount in the user’s default currency. The conversion rate used for this function is the exchange
rate dened in the exchange_rates table.
 
For example, for a user with a default currency of USD, to_currency(sa_products.c$price,
‘EUR’) returns an amount in USD that is equal to the number in the sa_products.c$price custom
eld converted to Euros.
 

How You Use Report Columns  

View the Column Right-Click Menu  
Numerous options that let you change a column’s display, positioning, and other options are available on the column’s
right-click menu.

The right-click menu is available for columns when you are viewing a report, or when you are editing a report on the
report designer. The options in this menu give you a large amount of control over how your columns display and
function, so it is important to understand the options available on the menu.

1. Open the report.
2. Right-click the header of the column you want to modify.

The right-click menu opens.

Buon Description

Edit Denition Select this option to open the Column Denition window where you can edit the
column heading, descriptions, and expression. See Add a Column to a Report. This
option displays only when editing a report on the report designer.

Edit Format Select this option to open the Column Format window where you can change the
column format, alignment, width, and styles. See How You Edit Column Formaing.

Edit Calculations Select this option to open the Calculations window where you can select calculations on
the column values to display beneath the column. Refer to Add Calculations to a Report
Column.

Sort Ascending

Sort Descending

Select these options to sort the values in the column in ascending or descending order.
See How You Change Report Sort Order.

Move Column Left

Move Column Right

Select one of these options to move the column left or right. You can also move
columns by dragging them on the design surface. These options display only when
editing a report on the report designer.

Insert New Column Before

Insert New Column After

Select one of these options to add a new column before or after the column you have
selected. When you select this option, the Column Denition window opens so you can
create the new column. These options display only when editing a report on the report
designer.
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Delete Column Select this option to delete the column from the report. You can also delete a column
by selecting the column and pressing Delete. This option displays only when editing a
report on the report designer.

Freeze Column
 

Click this buon to x the selected column in place so it does not move when you
horizontally scroll the report. This can be helpful if you want to continue to view the rst
column in the report while scrolling the report to see the columns on the right of the
report.
 
When you x a column, all columns to the left of the column are also xed. You can still
scroll the columns to the right of the xed column.
 

Hide Column Select this option to prevent the column from displaying in the report output. The
column is only hidden, so you can display the column when running the report if you
need to see it. For information about showing and hiding columns, see Hide or Show a
Column Using Right-Click Options.

Insert Hidden Column Select this option to view a list of any hidden or rolled-up columns in the report. Click
the hidden or rolled-up column you want to display. This option displays only when the
report has hidden columns.

Add a Column to a Report  
You can add a report column from either the data dictionary or the Column Denition window.

The procedures to add report columns are the same whether you’re adding standard or custom elds from the
database, functions, variables, or computed elds. If your column returns information directly from the database,
and does not require a complicated expression, you can add the column using the data dictionary. If your column’s
expression is complicated, perhaps using several functions, it can be easier to add the column from the Column
Denition window.

Note:  Each output level can have a maximum of 100 output columns. In addition, the number of tables used
in a report is limited to 20.

1. To add a column from the data dictionary:
a. Select the eld, function, variable, or computed eld you want from the data dictionary.

Note:  If the data dictionary is not shown on the design surface, click the Home tab and click
Data Dictionary to display it.

b. Drag the eld you selected to the data area on the design surface.

When you drag an item from the data dictionary to the data area, you can place it in any position. If other
columns are in the data area when you drag a eld, arrows appear between column headers indicating
where the eld will be placed. When the eld is in the desired location, drop it onto the data area.

2. To add a column from the Column Denition window:
a. Click the Home tab and click Add Column.

The Column Denition window opens.
b. Enter eld information.
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Heading*
 

Enter a heading for the column. This heading displays in the report output.
 

Use predened heading when
available
 

Select this check box to use the default heading for the column. This is the
name of the eld as it appears in the data dictionary.
 

Description
 

Enter an optional description for the column. Text that you enter in this
eld displays in the report when you include the Output Descriptions report
section. See Display Output Descriptions.
 

Available Columns/Functions
 

This area displays the data dictionary, which lists the available elds,
 functions, and parameters you can add as columns to the report. To add an
item, expand the tree, select the item, and drag it to the Expression section.
 
This option does not display when dening columns for computed elds.
 

Expression
 

This area displays the eld, function, or parameter you have dened as a
column. If you know the specic eld or function you want to add, you can
also enter it in this eld to add it as an output column without dragging it
from the Available Columns/Functions eld. You can also manually edit the
expression shown in this section. The Expression area does not display when
dening columns for computed elds.
 
The maximum number of characters allowed in the expression eld is 3,500.
You can use replacement variables to create expressions that require more
characters. See Add Report Variables.
 

c. Click OK to add the output column.

The column is added as the last column on the report level. See How You Edit Column Formaing for
information about how to reposition the column.

After you add columns to the data area, the report designer displays the columns on the design surface.
Four rows of sample text display beneath each column to give you an idea of what the report output will
look like.

Related Topics
• Create a Custom Report (video)

Remove a Column from a Report  
If you decide you no longer need a column in the report, you can remove it when working on the report designer.

1. Select the column you want to remove from the report.
2. Do one of the following:

◦ Click Delete on the Design tab.
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◦ Press Delete on your keyboard.

If the column you delete uses a table that is no longer needed in the report, you should remove the table from the report
to help the report run eciently.

Related Topics
• Change Table Joins and Linked Fields

Move a Column in a Report  
You can move columns when viewing or editing a report.

1. To move a column when viewing a report, click the header of the column you want to move and drag it to the
new position in the report.

2. To move a column when editing a report on the report designer, do one of the following.
◦ Drag the column to the new position in the report.

◦ Click Move Left or Move Right on the Home tab.

After moving the column, it displays in the new position on the report.

Add Calculations to a Report Column  
You can add rows to the boom of a column to display calculations performed on the column’s data. You can also
perform calculations on data rollups.

The Calculations window displays all the calculations that can be performed on the data in the column. If the report
does not have rollup columns, the Rollup Calculations section does not appear. Also, columns that do not contain
numeric values have only the Minimum, Maximum, and Median calculations available.

You can also add calculations from a selected column’s Design tab.

1. Right-click the column and select Edit Calculations.
The Calculations window opens.

2. If you select a rollup column, select the options you want for the column.
a. Select the Total check box to display the total value of the output column for all records.
b. Select the Minimum or Maximum check boxes to display the minimum or maximum values of the

output column for all records.
c. Select the Weighted Average check box to display the weighted average of the column for all records.
d. Select the Average check box to display the average value of the output column for all records.
e. Select the Median check box to display the median (middle) value of the output column for all records.
f. Select the Standard Deviation check box to display the standard deviation of the column for all records.

Standard deviation is the square root of the variance. It projects how various values in a set of values
deviate from the mean for that set.

3. Select calculations for columns.
a. Select the Total check box to display the total value of the output column for all records.
b. Select the Minimum or Maximum check boxes to display the minimum or maximum values of the

output column for all records.
c. Select the Weighted Average check box to display the weighted average of the column for all records.
d. Select the Average check box to display the average value of the output column for all records.
e. Select the Median check box to display the median (middle) value of the output column for all records.
f. Select the Standard Deviation check box to display the standard deviation of the column for all records.

Standard deviation is the square root of the variance. It projects how various values in a set of values
deviate from the mean for that set.

795



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

g. Click the Weighted Column drop-down menu and select the column to use in conjunction with the
current column to derive the weighted average.

This drop-down menu is activated when the Weighted Average report or rollup calculation is selected,
and displays only numeric columns you can use with weighted averages.

For example, if you have a report with column X showing the number of incidents solved by a group,
and column Y showing the average amount of time spent solving the incidents, a weighted average
calculation can determine the average amount of time spent solving each incident regardless of how
many incidents each group solved.

That is, if group A solves 30 incidents and averages 30 minutes per incident, and group B solves 10
incidents averaging 110 minutes per incident, a normal average would calculate 70 minutes per incident,
which would not reect the dierent number of incidents for each group. A weighted average would show
a more accurate average of 50 minutes per incident, since it takes the number of incidents solved by each
group into account.

The calculation used to determine weighted averages is (x1*y1)+(x2*y2)) / (x1+x2) or, in this example,
((30*30) + (10*110)) / (30 + 10) = 50.

4. Click OK.

Related Topics
• Dene Rollups

Add a Comparison Value Column to a Report  
You can view the same data for two dierent time periods side-by-side in a report by adding a comparison value
computed eld.

You can specify the time periods used, and change them while running the report to view the data for dierent time
periods. For example, you could have a report that shows the number of incidents created in the current week and the
number of incidents created in the previous week. You could then run the report again to compare numbers of incidents
created in the current month and previous month.

After you add a comparison value column to a report, the Comparison buon on the Home tab becomes active and you
can select the comparison time period. The comparison time period is relative to the time specied in a required date
lter you must add to the report.

1. Add an output column that returns values you want to compare. For example, if you want to compare the
number of incidents created from one week to the next, you could add a column for count to return a count of
incidents.

2. Expand the Computed Fields tree in the data dictionary.

Tip:  You can also add comparison columns by clicking the column you want to compare on the design
surface, clicking the Design tab, clicking the arrow on the Insert Column buon, and then selecting
the column you want to add.

3. Click the column you want to compare.
4. From the right side of the data dictionary, drag Comparison Value (column name) and drop it on the design

surface.
5. Click the Home tab.
6. Click Comparison and select Edit Comparison Date Oset.
7. Do one of the following:
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◦ Enter the relative value you want to use for the default comparison date oset. For example, entering -1
Weeks Exactly returns values in the comparison value column that are derived from data that is exactly
one week earlier than the data returned in the column that is being compared.

◦ Click the Calendar to specify relative date and time values. See Filter Date Ranges.

When you run the report, the default comparison date oset can be changed on the Search window. This lets
you to run the report several times to compare dierent time periods.

8. Click OK.
9. Add a xed or runtime selectable date lter to the report. This date lter is used to lter the data returned in the

column being compared and determines the time period that the comparison column’s relative comparison
date oset is based on.

Related Topics
• Filter Date Ranges

• Add a Comparison Percentage Column to a Report

• Change Column Comparison Options

Add a Comparison Percentage Column to a Report  
After adding a comparison value column to a report for a numeric eld, you can then add a Comparison Percentage
computed eld column to the report.

Before adding a comparison percentage column, you must rst add a comparison value column to the report. See Add a
Comparison Value Column to a Report.

This column returns the percentage dierence between the comparison value column and the column being compared.
For example, if a value in the compared column is 10, and the corresponding comparison value is 15, the percentage
dierence would be 50%.

1. Expand the Computed Fields tree in the data dictionary.

Tip:  You can also add comparison percentage columns by clicking the comparison column you added
on the design surface, clicking the Design tab, clicking the arrow on the Insert Column buon, and
then selecting Comparison % Change.

2. Click the comparison value column you added.
3. From the right side of the data dictionary, drag the Comparison Percentage column name and drop it on the

design surface.
4. To set options for the column, right-click the column on the design surface and select Edit Comparison

Percentage Options.

Tip:  You can also adjust options by selecting the column and using the buons on the Design tab’s %
Change group.

5. Enter eld information.

Field Description

Comparison Direction Select whether the comparison column or the compared column is used as the initial
column to derive the comparison percentage.
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Comparison Data to Report Data Select this option to use the comparison value column as the initial column to derive the
comparison percentage. If the value in the comparison value column is greater than the
corresponding value in the compared column, a positive percentage is returned.
 

Report Data to Comparison Data Select this option to use the compared column as the initial column to derive the
comparison percentage. If the value in the compared column is greater than the
corresponding value in the comparison value column, a positive percentage is returned.
 

Display Change Icon Select this check box to display icons next to the percentage values returned in the
column. The icons indicate whether there is a positive change, negative change, or no
change. To alter the colors used for the icons, click the icon to open the Color window.
See Change Colors.
 

6. Click OK.

Change Column Comparison Options  
You can modify the comparison value columns that you have added to a report.

When using comparison values in a report, the comparison and compared values do not necessarily display on the
same row as the corresponding values in the other column. This is because a value is not automatically returned in a
comparison column if there are no records to return.

For example, if a report outputs numbers of incidents assigned to two sta members during the current week and
previous week, but the top sta member listed in the report had no incidents assigned in the previous week, there will
not be an entry for that sta member in the comparison value column. This results in the comparison value for the
second sta member displaying on the rst row of the report.

To prevent this, you can set comparison options to have the report output a zero for any rows that lack a value in a
column. This results in the corresponding values lining up with one another.

1. Add a comparison value column to a report.
2. Click the Home tab.
3. Click Comparison and select Edit Comparison Match Columns.
4. Select the column(s) that dene the corresponding values.
5. Move the selected column to the Comparison Match Columns panel by dragging the eld or clicking the right

arrow.
6. Click OK.

Related Topics
• Add a Comparison Value Column to a Report

Add a Trend Value Column to a Report  
Trend value computed elds are similar to comparison value computed elds. However, where comparison value
columns return data from previous time periods, trend value columns return forecasts of data in future time periods,
calculated from current data.

798



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Trend values are best used when trending a column that groups data together by a time period, such as a column that
shows the number of incidents created in the same week.

Tip:  You can also add trend value columns by clicking the column you want to trend on the design surface,
clicking the Design tab, clicking the arrow on the Insert Column buon, and then selecting Trend Value.

1. Add a numeric output column that returns values you want to trend.
For example, if you want to forecast the number of incidents that will be created in future weeks, you could add
a column for count(incidents.i_id) to return a count of incidents.

2. Expand the Computed Fields tree in the data dictionary.
3. Click the column you want to trend.
4. From the right side of the data dictionary, drag the Trend Value column name and drop it on the design surface.

Related Topics
• Add a Trend Percentage Column to a Report

• Change Trend Options

Add a Trend Percentage Column to a Report  
After adding a trend value column to a report, you can then add a Trend Percentage computed eld column to the
report.

Before adding a trend percentage column, you must rst add a trend value column to the report. See Add a Trend Value
Column to a Report.

You can add a Trend Percentage column, either from the data dictionary or the Design tab’s Insert Column buon.
Trend Percentage columns return the percentage dierence between the trend value column and the column being
trended. For example, if a value in the trended column is 10, and the corresponding trend value is 15, the percentage
dierence would be 50%.

1. Expand the Computed Fields tree in the data dictionary.
2. Click the trend value column you previously added to the report.
3. From the right side of the data dictionary, drag the Trend Percentage column name and drop it on the design

surface.
4. To set options for the column, right-click the column on the design surface and select Edit Trend Percentage

Options.

Tip:  You can also edit trend percentage options from the % Change group on the Design tab.

5. Enter eld information.

Field Description

Comparison Direction Select whether the trend value or the trended column is used as the initial column to
derive the trend percentage.

Trend Data to Report Data Select this option to use the trend value column as the initial column to derive
the trending percentage. If the value in the trend value column is greater than the
corresponding value in the trended column, a positive percentage is returned.
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Field Description

Report Data to Trend Data Select this option to use the trended column as the initial column to derive the trending
percentage. If the value in the trended column is greater than the corresponding value
in the trend value column, a positive percentage is returned.

Display Change Icon Select this check box to display icons next to the percentage values returned in the
column. The icons indicate whether there is a positive change, negative change, or no
change. To alter the colors used for the icons, click the icon to open the Color window.
See Change Colors.

6. Click OK.

Change Trend Options  
Change trend options to specify the number of time units that are forecast forward for a trend value or trend percentage
column.

When using forecasting, you can select the time period that you want to use. For example, if the trended column groups
data by week, trending forward three units shows data trended three weeks in the future.

Tip:  You can also edit trend options from the Trend Options group on the Design tab after selecting the
column on the design surface.

1. Right-click the trend value column on the design surface and select Edit Trend Options.
2. Select the Perform Forecast check box to enable forecasting.
3. Enter the number of units.
4. Click OK.

Related Topics
• Add a Trend Percentage Column to a Report

• Add a Trend Value Column to a Report

How You Edit Column Formaing  
You can change formaing options for your report columns to change how they look, or to change how their data is
presented.

When you edit a report or view an existing report, you can change the formaing for the report’s columns. Most of
these options are the same for all columns and let you adjust column fonts, width, alignment, and similar properties.
Other formaing options that impact how data displays vary depending on the type of information the column returns.
For instance, a column that displays numbers will have dierent data options than a column that displays text.

When viewing reports you select format options from the Column Format window. When using the report designer, you
can select from options in the Column Format window, or use buons on the Format tab. The tab includes the most
commonly used options available in the window.

If you change column format options when viewing a report, those changes are lost when you close the report. To save
formaing changes on a custom report, you must edit it on the report designer.

Edit Column Alignment Options  
Change the way text is displayed in a report column.

1. Right-click the header of the column you want to modify and select Edit Format.
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The Column Format window opens.
2. Click the Alignment tab.
3. Enter eld information.

Field Description

Header The elds in this section determine the alignment for the column’s header.

Text Alignment Click this drop-down menu to select the column header’s horizontal alignment. Options
include Left, Center, and Right.

Line Alignment Click this drop-down menu to select the column header’s vertical alignment. Options
include Boom, Center, and Top.

Wrap Text Select this check box to allow the column header’s text to wrap to a new line if it exceeds
the width of the column.

Data The elds in this section determine the alignment for the column’s data.

Text Alignment Click this drop-down menu to select the horizontal alignment for the column’s data.
Options include Left, Center, and Right.

Line Alignment Click this drop-down menu to select the vertical alignment for the column’s data.
Options include Boom, Center, and Top.

Wrap Text Select this check box to allow the column’s data to wrap to a new line if it exceeds the
width of the column.

Limit Wrapped Text to x Rows If the Wrap Text check box is selected, enter the maximum number of wrapped rows
that should be shown in the report output. You can enter a value between 1 and 100.

Repeating Values The elds in this section let you hide repeating values in the column.

Hide Repeating Values Select this check box to hide repeating values in the column. The value will display in the
rst row with value, but subsequent rows with the same value will be blank. Selecting
this option can make a report’s output more legible by hiding repetitive text in a column.

Exclude Hidden Values from
Calculations and Auto-Filtering

Select this check box to exclude hidden values from consideration in column
calculations and column auto-lter options.

Edit Column Width Options  
Change the width of a column in a report.

1. Right-click the header of the column you want to modify and select Edit Format.
The Column Format window opens.

2. Click the Width tab.
3. Select the width seing you want.

◦ Best Fit—Select this option to automatically size the column width to best t in the report.

◦ Specic Width—Select this option to dene a width for the column. Enter the width of the column and
select the unit to use from the drop-down menu. You can choose Percentage (of the total width of the
report), Pixel, Inch, Cm (centimeter), Mm (millimeter), Pica, Point, Em, and Ex.
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Edit Column Style Options  
Change the format of text that appears in a report column.

1. Right-click the header of the column you want to modify and select Edit Format.
The Column Format window opens.

2. Click the Styles tab.
Text styles control the font, color, margins, background colors, and borders for text elds. The current seing
for each text eld’s style is shown next to the name of the text eld.

3. Enter eld information.

Field Description

Data Headings Click Edit to dene the style for the column’s heading when the report is shown with a
tabular layout.

Rollup Headers Click Edit to dene the style for the rollup headers if shown in the report’s output.

Record Labels Click Edit to dene the style for the column’s heading when the report is shown with a
record layout.

Record Data Click Edit to dene the style for the column’s data when the report is shown with a
record layout.

Data Dene the style for the data text in the column when the report is shown with a tabular
layout.

◦ Click Edit to edit the style that is currently used for the data text in the column.

◦ Click Add to add other styles for alternating data rows in the column. The new
style you create is initially identical to the original data style. After you add the
new style, another data style appears. The data rows in your report then alternate
between the two styles you have dened. If you add a third data style, it is used in
every third row.

◦ Click Remove to remove the new data style. Remove appears next to new data
styles you add. You cannot remove the original data style.

Rollup Totals Click Edit to dene the style for the rollup totals if shown in the report’s output.

Report Totals Click Edit to dene the style for the report totals headers if shown in the report’s output.

Apply Styles to All Columns Click this text to apply the styles you dened on this tab to all the columns currently in
your report.

Edit Conditional Format Options  
You can change how values display in a column based on conditions you specify.

Conditional formaing ags information in output columns without creating a data exception. For example, you could
add formaing to a column in an incidents report to display the column’s output in red text if an incident’s status is
Unresolved. Multiple format options can be used to ag output using images, background colors, and fonts.

Conditional formaing is not available for columns that return hierarchical values.

1. Right-click the header of the column you want to modify and select Edit Format.
The Column Format window opens.

2. Click the Conditional tab.
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3. Click Add. The Conditional Format window opens.

The options shown on the Condition tab depend on the type of data output in the column the condition is
added to. For example, a column that outputs dates has operators and values that are unique to date elds.

4. Select the operator and value(s) you want agged.
5. Click the Format tab to dene how the agged data is displayed.
6. Enter eld information.

Field Description

Display Click this drop-down menu to select the type of formaing you want to use to indicate
column output that meets the selected condition(s).

Image and Text Select this option to show images next to the column output that meets the selected
condition(s) and display the output with dierent font options.

Image Only Select this option to show an image next to the column output that meets the selected
condition(s).

Text Only Select this option to use dierent font options for column output that meets the
selected condition(s).

Image Click this drop-down menu to select the image to display. Options include Circle, Square,
Flag, Check, Up Arrow, Down Arrow, and Custom. Select Custom to select the image
from the Images explorer.
This drop-down menu is disabled if Text Only is the selected display option.
 

Change Color Click this text to change the color of the selected image.
The color of custom images cannot be changed.
 

Preview This eld displays a preview of the selected image, text, or both, depending on the
selected display option.

Change Style Click this text to select font aributes for conditional column text.

7. Click OK.
8. If multiple conditional formats are applied to the column, dene the order in which the formats should be

applied.

Multiple conditional formats can be applied to the same column to indicate dierent values. For example,
dierent incident statuses can have dierent font colors or images. When a column has multiple formats, the
order of the conditions is important since this determines which condition is applied rst. If a row in a report
meets both the rst and second conditions in a column, only the rst condition is applied to the value.

a. Select the conditional format to move from the Conditional Formats list.
b. Click the Move Up or Move Down arrows to move the conditional format up or down in the list.

Edit Data Type Column Format Options  
The options for editing a report column vary depending on the column data type.

1. Right-click the header of the column you want to modify and select Edit Format.
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The Column Format window opens, and the tab on the upper-left of the window is active. The tab’s contents
vary depending on whether you are editing a column that contains text, dates, numbers, or currency. The elds
available on the Text, Date, Number, and Currency tabs are described in the following tables.

2. To dene options for a text column, enter the eld information described here.

Field Description

Text Length Dene limits to the length of text strings appearing in the column.
 

Do not limit text length Select this option to allow an unlimited length of text strings in the column. The column
is automatically resized to t the length of the output text.
 
This option is not available for menu type elds.
 

Limit text to x characters Select this option to limit the text string length to a certain number of characters and
then enter the number of characters. Text strings that exceed this value are truncated.

Text Options Dene options to determine how column contents are displayed.

Display “more” link when text width
exceeds cell width

Select this check box to display a link in a row whose text exceeds the allowed width of
the column. When a link is displayed, you can click the link or hover over it to open a
window with the full text.

Display tooltip when cell text
exceeds cell bounds

Select this option to display a tooltip showing the eld’s entire text entry when hovering
over a eld with a text entry that exceeds the width of the column.
 
This option is available only from the Options buon on the Format tab.
 

Strip HTML tags Select this check box to remove HTML tags from text that is displayed in a column.

NULL Values Dene how NULL values in the database should display.

Display Blank Select this option to display a blank for NULL values.

Display as No Value Select this option to display No Value for NULL values.

3. To dene options for a date column, enter the eld information described here.

Field Description

Date Format Click this drop-down menu to select the date format you want to use for date elds.
Options include Date Time, Long, Short, Month Year, Clock, Month Day, Year, Date Time
(time zone), and Custom.
 
When you select any option other than Custom, the selected format displays in the
Format String eld so you can see the string that is used for the selected format.
 

804



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Field Description

Format String Enter the format string for the custom date format in this eld when the Custom date
format option is selected.

NULL Values Dene how NULL values in the database should display.

Display Blank Select this option to display a blank for NULL values.

Display as No Value Select this option to display No Value for NULL values.

4. To dene options for a numeric column, enter the eld information described here.

Field Description

Show Value As Click this drop-down menu to select the format to use when displaying content in
numeric columns. Options include Number, Seconds, Minutes, Percent, and File Size.
 
The options available on the Number tab vary depending on the selected value format.
 

Digit Grouping Dene whether digits are grouped in threes. For example, instead of the column
returning 123456, you can group the digits to return 123,456.
 
This option appears only when the selected value format is Number, Decimal, or
Percent.
 

Do not show group separator Select this option to prevent the values in the column from including a separator
character.

Use default group separator Select this option to use the default group separator character. The default separator is a
comma.

Use custom group separator Select this option to dene your own group separator character. Enter the character you
want to use in the eld.

Decimal Dene how decimal and percentage formats should be displayed.
 
This option appears only when the selected value format is Percent.
 

Decimal Places Enter the number of decimal places to display in the output.

Use default decimal separator Select this option to use the default group separator character. The default separator is
a period.

Use custom decimal separator Select this option to dene your own decimal separator character. Enter the character
you want to use in the eld.

Multiply by 100 Select this check box to multiply the decimal values by 100.
 
This option appears only when the selected value format is Percent.
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Field Description

 

Seconds When the column outputs a value in seconds, specify the format you want to display the
time in. The available options are Days, Hours, Minutes, and Hours, Minutes, Seconds.

Minutes When the column outputs a value in minutes, specify the format you want to display the
time in. The available options are Days, Hours, Minutes, and Hours, Minutes.

NULL Values Dene how NULL values in the database should display.

Display Blank Select this option to display a blank for NULL values.

Display as 0 Select this option to display 0 for NULL values.

5. To dene options for a currency column, enter the eld information described here.

Field Description

Use Default Currency Format Select this option to use default currency seings, as specied by your administrator.
When this option is selected, most of the other elds on the Currency tab are disabled.

Use the Following Format Options Select this option to dene your own currency format seings. When you select this
option, the elds on the Currency tab are enabled.

Display Symbol Select this option to display the symbol for the currency. For example, ten U.S. dollars
would display as $10.00.

Display Code Select this option to display the code for the currency. For example, ten U.S. dollars
would display as 10.00USD.

Digit Grouping The options in this section let you group digits in threes. For example, instead of the
column returning $123456, you can group the digits to return $123,456.

Do Not Show Group Separator Select this option to prevent the values in the column from including a separator
character.

Use Default Group Separator Select this option to use the default group separator character. The default separator is a
comma.

Use Custom Group Separator Select this option to dene your own group separator character. Enter the character you
want to use in the eld.

Decimal Dene how decimal and percentage formats should be displayed.

Decimal Places Enter the number of decimal places to display in the output.

Use Default Decimal Separator Select this option to use the default group separator character. The default separator is
a period.

Use Custom Decimal Separator Select this option to dene your own decimal separator character. Enter the character
you want to use in the eld.
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Field Description

NULL Values Dene how NULL values in the database should display.

Display Blank Select this option to display a blank for NULL values.

Display as 0 Select this option to display No Value for NULL values.

Add URL Links to a Column  
You can dene report column cells as URL links.

When you click a URL link in a report, your web browser launches and the website the URL points to opens. You can
customize the URL and add variables to the link, using the values in any of the report’s columns. For example, you
could direct a URL to open an answer on the customer portal, or you could direct the URL to a page designed by your
organization.

1. Right-click the header of the column you want to modify and select Edit Format.
The Column Format window opens.

2. Click the URL tab.
3. Enter eld information.

Field Description

None Select this option to clear URL options.

Display Cell Value as Link Select this option to enable URL options for the column. This lets you link to a website
using either the value displayed in the eld or a custom URL.

Display Cell Value as Image Select this option to enable image options for the column. This lets you store images on
a separate server and display the images in the column. Since you can point to external
locations for the image les, you do not need to upload the images to Oracle Service
Cloud. Instead, you specify the URL where the image you want to display is stored. See
Display External Images in a Report Column.

Use Cell Value as URL Select this option to use the value in the eld as the URL link. Use this only if the value in
the eld is a valid URL.

Use Custom URL Select this option to manually specify the URL. You can enter the URL you want in the
text box, or click Advanced URL Denition to view options to help you dene the URL.

Advanced URL Denition Click this text to display advanced URL formaing options.
When you click Advanced URL Denition, the text changes to read Simple URL
Denition. Click this text to hide the Advanced URL Denition options.
 

Report Column Selection You can add variables and variable values to the custom URL in this section. Enter the
variable you want to add to the URL in the text eld, and then select the column to use
to populate the variable’s values from the drop-down menu.

Target Enter the value you want for the customer portal URL’s target aribute in this eld. This
is optional and is used to specify where the customer portal page that is linked to opens.
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Field Description

This can be used to customize the browser window used to display content customers
can view, such as answers.

Append Session ID Select this check box to append the session ID number to the URL. Use this option when
the URL links to a customer portal page to ensure the URL for the page is valid.

Begin with Server End-User URL Select this check box to automatically prepend the path to the Oracle Service Cloud
server to the custom URL.

Begin with Answers Detail URL Select this check box to automatically prepend the path to the customer portal’s
answers detail page to the URL. This is dened in the CP_ANSWERS_DETAIL_URL
conguration seing.

Begin with Server Admin URL Select this check box to automatically prepend the path to the Oracle Service Cloud
server’s PHP directory to the custom URL.

Open URL in You can use the options in this section to specify where you want the web page that is
linked to from the column to open.

Default Browser Select this option to open the web page in the computer’s default browser. A new
browser window opens if one is not already open.

Popup Window Select this option to open the web page in a new window.

Print Dialog Select this option to open the web page in the Print window. You can then print the
content displayed in this window.

Add Gauge Charts to a Column  
You can display numeric or currency values in a column as gauge charts. Several types of gauges are available.

1. Right-click the header of the column you want to modify and select Edit Format.
The Column Format window opens.

2. Click the Gauge tab.
3. Enter eld information.

Field Description

Inline Gauge Type Click this drop-down menu to select the type of gauge you want to use. Options include
None, Linear Gauge, Circular Gauge, Progress Bar, LED, and Status Gauge.

Display Numeric Value Select this check box to display numeric values on the gauge.

Orientation This option displays only when Status Gauge is selected. You can choose Circular to
display the information using a circular line, similar to a donut chart. You can also
choose Horizontal to display the information using a horizontal line.

Show Reference Marks This option displays only when Status Gauge is selected. Select this check box to display
lines on the status gauge where your gauge color ranges are congured. For instance,
if you congure ranges of 0%–50% and 51%-100%, a line will display at the midpoint of
the gauge between the two ranges.
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Field Description

Size Dene the size of the gauge in this section.

Best Fit Select this option to allow the width of the gauge to be automatically sized to the best t
for the report.

Specic Width Select this option to dene a width for the gauge. Enter the width of the gauge and
select the unit to use from the drop-down menu. You can choose Percentage (of the
total width of the column), Pixel, Inch, Cm (centimeter), Mm (millimeter), Pica, Point, Em,
and Ex.

Bar Size Dene the bar size of the gauge in this section. This section is available only for the
Status Gauge type.

Best Fit Select this option to allow the width of the gauge’s bar to be automatically sized to the
best t for the report.

Specic Width Select this option to dene a width for the gauge’s bar. Enter the width you want for the
bar size and select the unit to use from the drop-down menu. You can choose You can
choose Percentage (of the total width of the column), Pixel, Inch, Cm (centimeter), Mm
(millimeter), Pica, Point, Em, and Ex.

Scales Dene the scale ranges used for the gauge in this section.

Scale Start/Scale End Enter the starting value (lowest value) and ending (highest value) for the gauge’s scale
in these elds.
These options are enabled only when dening a custom scale.
 

Use Report Min Select these check boxes to use the lowest value or highest value returned in the
column as the scale start value.

Use Report Max Select this check box to use the highest value returned in the column as the scale end
value.

Colors Select colors used for the gauge in this section. This section is not available for LED
gauges.

Indicator Color Click this color box to select the color to use as the gauge indicator color. This option is
not available for the LED or Status Gauge types.

Border Color Click this color box to select the color to use as the gauge border color.

Gauge Color Ranges Add color ranges and dene range colors in this section. Color ranges are optional, but
can be used to display numeric values in dierent colors. The graphic that indicates the
value of the eld in the report displays in the color congured for the range the value
falls in. Range values cannot contain gaps or overlap.
Color ranges are not available with Progress Bar gauges.
 

Add Range Click this text to add a color range.
A maximum of ve ranges can be shown on the gauge.
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Field Description

Remove Range Click this text to remove a range you have added.

Minimum/Maximum Enter the starting and ending value for the range in these elds.

Start Color/End Color Click these color boxes to select colors to indicate the start and end points of the range.

4. Click OK.

Display External Images in a Report Column  
If you store images on a separate server, you can display those images in report columns.

Since you can point to external locations for the image les, you do not need to upload the images using the Images
explorer. For instance, you can create a text system aribute for the Accounts standard object to store the URLs to
photos of your sta members. You can then display the photos in reports that include the system aribute eld.

There are some considerations when conguring column image options.

• Column format image options can only be congured using the report designer. They cannot be congured
when viewing a report.

• Some restrictions exist on the external images you can display in reports. Each image le must be smaller than
500K in size, and a maximum of 100 unique images can be displayed each time the report is generated. (If you
generate the same report multiple times using dierent search criteria, dierent images can be displayed.) In
addition, to ensure reports run successfully, retrieval of the images times out after 10 seconds.

• External images will display in exported, published, and printed reports. However, they do not display in
scheduled reports.

• The image le formats you can use in reports are BMP, EXIF, GIF, JPEG, PNG, and TIFF. If an unsupported le
type is encountered when the report runs, the column output displays Invalid Image.

1. Open the report you want to add the image to on the report designer.
2. Right-click the column on the report where you want the image displayed and select Edit Format.

The Column Format window opens.
3. Click the URL tab, and then select Display Cell Value as Image.
4. To specify a custom size for the images, select the Scale All Images to the Following Size check box and select

width and height values between 1 and 500 pixels.
By default, images are sized to 100x100 pixels.

5. In the text box, enter the URL of the image le.
6. Click OK.
7. Click Save.

Related Topics
• Images Explorer

Create a Data Exception  
You can create data exceptions to highlight data displayed in columns or charts that meets certain criteria.

Exceptions can be created to ag data that matches expressions built from standard and custom database elds,
functions, and variables. For example, you could create an exception to ag incidents with a response time greater than
twenty-four hours. Incidents that match the exception could be shown on the report with custom colors, fonts, and
markers. Information about the percentage of data meeting the exception can also be displayed.
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Tip:  Each report level can have a maximum of thirty-two data exceptions.

After you dene your exceptions, you can schedule the report to send alerts whenever the criteria of a data exception is
met. See How You Schedule Reports.

1. Click Exception on the Insert tab.
The Exception Editor opens.

2. Enter eld information.

Field Description

Name
 

Enter the name of the data exception.
 

Display Reference
 

Click this drop-down menu to select how the data is highlighted. Options are Entire Row
or specic columns from the report.
 

Expression*
 

Right-click in this eld to select the database column used to except data in the report.
 

Use Data Dictionary
 

Click this text to open the Edit Expression window where you can select functions,
 variables, and database elds.
 

Operator
 

Click this drop-down menu to select the operator to use in the exception criteria. This
drop-down menu is activated when a database column is selected. See Overview of
Filter Operators for a description of operators.
 

Value
 

Specify the second part of the expression in this eld. The options available depend on
the selected value type, the type of database eld the exception is based on, and the
operator that is used. You can type in a value, select items from a drop-down menu, or
select dates from calendars.
 

3. To dene how the data exception displays in the report’s tabular output, click the Tabular Display tab.
4. Enter eld information.

Field Description

Show Tabular Notication
 

Select this check box to display the data exception in the report’s tabular output. If this
option is cleared, the other options on the Tabular Display tab are unavailable.
 

Use Default Display Options
 

Select this option to display the exception using the color, font, and marking method
dened in the style that is being used for the report. See Styles Explorer for information
about creating styles and Apply a Style to a Report for information about applying styles
to reports.
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Field Description

Use Custom Display Options
 

Select this option to dene a custom color, font, and data marking method for the
exception.
 

Data Marking
 

Click this drop-down menu to select a data marking to mark the data that meets your
exception criteria. You can choose None, Circle, Square, Flag, Check, Up Arrow, Down
Arrow, or Custom.
 
Select Custom to open the Select Image window and select images you have added in
the Images explorer. See Images Explorer.
 
Select None to prevent a graphic from indicating the data exception. The text style
you dene for the marker will still be applied to the data exception. This allows you
to change the color or font of tabular data that meets the exception without adding a
graphic.
 
The data marking symbol displays in the window’s Preview eld so you can view the
symbol as you dene it.
 

Hide Cell Values
 

Select this check box to hide the value in the column that is used as the display
reference.
 
This check box is available if the exception’s display reference is set to a column rather
than an entire row.
 

Change Color
 

Click this text to open the Color window to change the color of the graphic. See Change
Colors.
 
This option appears if Circle, Square, Flag, Check, Up Arrow, or Down Arrow is selected
in the Data Marking drop-down menu.
 

Change Image
 

Click this text to open the Select Image window to change the image data marking
image.
 
Change Image appears only if Custom is selected in the Data Marking drop-down menu.
 

Style
 

Click Add next to the Style box to open the Edit Style window where you can change
the font, colors, margins, and borders for the data in the report that matches your data
exception criteria.
 
To remove a style that has already been dened, click Clear next to the Style box.
 

Show Exception Criteria
 

Select this check box to display the exception criteria at the boom of the report in the
Data Exceptions report section. For example, if the data exception marks opportunities
that are still active, the criteria displays as opportunities.status_id = Active.
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Field Description

 

Show Percentage Meeting Criteria
 

Select this check box to show the percentage of data in the report that meets the
specied exception criteria. This displays at the boom of the report on the Data
Exceptions report section.
 

Show Percentage Not Meeting
Criteria
 

Select this check box to show the percentage of data in the report that does not meet
the specied exception criteria. This displays at the boom of the report on the Data
Exceptions report section.
 

5. To dene how the data exception displays in the report’s graphical output, click the Graphical Display tab.
6. Enter eld information.

Field Description

Show Graphical Notication
 

Select this check box to display the data exception in the report’s chart output. If this
option is cleared, the other options on the Graphical Display tab are unavailable.
 

Use Custom Display Options
 

Select this option to choose your own line color for the data exception. If this box is not
selected, the exception uses the line color dened in the chart style that is being used
for the report. See Chart Styles Explorer for information about creating chart styles and
How to Add and Edit Charts for information about applying chart styles to reports.
 

Line Color
 

Click the color box to open the Color window and select a line color for the excepted
data. See Change Colors.
 

Show Exception Criteria
 

Select this check box to display the exception criteria in an exceptions box in the chart.
 

Show Percentage Meeting Exception
 

Select this check box to show the percentage of data in the report that meets the
specied exception criteria. This displays in an exceptions box in the chart.
 

Show Percentage Not Meeting
Exception
 

Select this check box to show the percentage of data in the report that does not meet
the specied exception criteria. This displays in an exceptions box in the chart.
 

Related Topics
• Order Data Exceptions

Order Data Exceptions  
When you have more than one data exception based on the same database eld in a report output level, the ordering of
the exceptions can impact which exception the data matches.
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When you have multiple data exceptions, you may want the most restrictive exception listed rst, since the data is
checked against the rst exception before other exceptions in the list are matched. For example, you could create
exceptions in a report that show the number of open incidents each of your contacts have. You could create an
exception to indicate contacts with ve or more incidents and another exception to indicate contacts with ten or more
incidents. If the rst exception is count(incidents.i_id) > 5, and the second is count(incidents.i_id) > 10, then your
data would match only the rst exception even if a row had an incident count greater than ten. This occurs because the
rst exception has precedence over the second exception. To correct this, you would reorder the data exceptions.

1. Select the data exception you want to move on the design surface.
2. Click the Design tab.
3. Click Move Up or Move Down to move the exception to the position you want.

Tip:  You can also reorder exceptions by dragging them in the exceptions report section on the design
surface.

Related Topics
• Create a Data Exception

Set Record Row Limits and Page Breaks  
You can limit the number of rows returned on each page or on the entire output of a report.

Reports can return large amounts of data, especially if they lack xed lters or required runtime selectable lters. It
can be dicult to print or view a report with thousands of rows, and nding specic records in such a report can be
challenging. For these reasons, you might want to limit the number of rows a report can return on a page or in total.

You can set limits for each output level in the report.

1. Select the level you want to add the record limit to from the Level drop-down menu at the top of the design
surface.

2. Click the Level tab.
3. Click the Record Limit buon.
4. Enter eld information.

Field Description

Limit To Select this check box to limit the records returned on the output level.

Rows Enter the maximum number of rows you want returned.
The VRL_HARD conguration seing sets a hard limit on the number of rows that can
be returned in a report. Values entered in this eld that exceed the VRL_HARD limit
are ignored. See Analytics Conguration Seings for information about this and other
conguration seings that can impact reports.
 

Per Page Select this check box to apply the record limit to each page of the report. If this check
box is not selected, the row limit you enter restricts the total number of rows returned in
the selected output level.

5. Click OK.
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Overview of Table Relationships in Reports  
You can link tables in dierent reports so that they function like a single report.

When you use elds from dierent database tables in a report’s columns or lters, the elds’ tables are automatically
added to the report, and the tables are joined by their elds that are linked together in the database. Tables such as
incidents and contacts are tied together with a single eld in each table, specically the incidents.c_id and contacts.c_id
elds. Since there is only one way to link these tables together, Analytics links them in the report automatically using a
table join. By joining the tables, information from both tables can be displayed together.

Note:  When viewing a report, you can see the report’s tables in the report denition. See View a Report
Denition. When editing a report, you can see and manage the report’s tables by clicking the Tables buon on
the Home tab of the report designer’s ribbon. See How to Change Table Relationships.

Some reports you create may need to reference numerous tables with dierent relationships. For example, you may
need to use elds from tables that aren’t linked together in the database, or you may need to use elds from tables that
can be linked together in more than one way. In these instances, you will need to select the elds you want to use to join
the tables.

In addition, if you require a high degree of control over the tables used in a complex report, you can manually add them
to the report instead of having the tables added automatically. See Add Tables to a Report Manually.

Note:  In general, we recommend using as few tables as possible in a single report to help the report run
eciently. If you need to reference numerous tables in a report to return a wide array of information, you can
instead create multiple reports, each with a minimum of tables that are focused on one area of the information
you’re interested in. You can then link the tables together so they function like a single report. See Overview of
Linked Reports.

How to Change Table Relationships  
If you create a report that returns data from multiple tables and nd that the data you want is not being returned, you
may need to change the relationships of the report’s tables.

You can change the order of the tables, the join types connecting the tables, and the specic elds that are linked
together in the tables, as long as the elds are linked in the database. You can also delete tables that are no longer
needed in the report.

Related Topics
• Change Table Ordering

• Change Table Joins and Linked Fields

Change Table Joins and Linked Fields  
You can edit your report’s data set to change the tables’ join types. In addition, if the tables can be linked by more than
one eld, you can select a new eld to link to.

1. Click the Home tab.
2. Click Tables to open the Data Set window.
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When you open the Data Set window, you see the tables in your report and their relationships. When two
tables are inner joined, two overlapping circles with their intersection highlighted display next to the secondary
table. When two tables are outer joined, two overlapping circles with one circle highlighted display next to the
secondary table.

3. Click the table that is joined to the primary table.
4. Enter eld information.

Field Description

Table
 

This eld displays the database name of the table you have selected.
 

Delete Table
 

Click this text to remove the table you have selected from the report. If the table acts as
a parent to other tables in the report, the child tables are also removed.
 
Columns are not automatically removed from the report when their associated tables
are deleted. These need to be manually removed before the report can be saved.
 

Alias
 

This eld displays the alias name of the table you have selected. The alias allows you
to add multiple instances of the same database table to the same report. For example,
 the rst instance of the contacts table could have an alias of “contacts,” and the second
instance could have an alias of “contacts2” to distinguish it from the rst instance.
 

Join To
 

This eld displays the table the selected table is joined to.
 

Join Condition
 

If the table join can link to more than one eld in the joined tables, click this drop-down
menu to select the elds you want to use to join the tables.
 

Join Type
 

Select the Inner option to use an inner join or the Outer option to use an outer join.
 
To change the join type, you can also right-click the joined table in the data set tree and
select Toggle Join Type.
 

Join Filters
 

You can add, delete, or view join lters in this section.
 
Join lters apply only to outer joins and are not available if the Inner join type option is
selected.
 

Related Topics
• Overview of Table Joins

• How to Create Join Filters

Change Table Ordering  
When using outer joins to combine tables, the ordering of tables can aect what data the report can return.
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If multiple tables are used in the report, you may also need to change which secondary tables are directly linked to the
primary table or change the relationships between secondary tables in the data set.

1. Open the Data Set window.
2. To select a dierent table in the data set as the primary table, right-click the table and select Set as Root.

When you set a new table as the root, or primary table, the relationship between the table and the old primary
table is broken, resulting in the data set having two primary tables.

3. To move a table beneath another to make it a secondary table, drag the table onto the primary table.
The tables are automatically joined and the new table relationship is displayed on the Data Set window.

Related Topics
• Overview of Table Joins

Add Tables to a Report Manually  
If you require a high degree of control over the tables used in a complex report, you can manually add them to the
report instead of having the tables added automatically.

To ensure report queries are ecient, manually adding tables to a report should be performed only by individuals with a
thorough understanding of SQL queries.

1. Delete all columns and lters from an existing report, or start with a report with no columns.
2. Click Tables on the Home tab.

The Data Set window opens.
3. Click Select Table.

A list of all tables displays.
4. Select the table you want from the list.
5. Click OK to add the table to the report.
6. To join additional tables to the table you added, right-click the table you added, select Join To, and select the

table to join.
7. Repeat step 6 for each table you want to add.

Overview of Table Joins  
Analytics uses inner and outer table joins. The join type that is used to link the tables in your report impacts what
records the report can return.

Generally, you do not need to specify which elds are used to join tables together in reports since the tables that are
commonly used in reports are often joined automatically. However, some tables can be joined through more than one
eld and other tables do not have linked elds in the database and cannot directly join together. If you encounter one
of these situations when adding a eld to a report, you need to specify how the tables are joined. You may also need to
change the join type to allow the report to access the appropriate records in the tables.

Note:  The relationships between custom object tables and other tables are dened when the custom object is
created. See Overview of Custom Objects.

Inner Joins
When tables are linked with an inner join, only records in the tables that share common data can be returned. For
example, when the contacts table and the incidents table are linked with an inner join, only contacts that have incidents
associated with them can be returned by the report. Information about a contact who has never submied an incident
cannot be returned.
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Inner joins are used when tables are automatically joined together since they meet the requirements of most reports
and are easier to process in database queries than outer joins.

Outer Joins
When tables are linked with an outer join, all rows from the rst table added to the report (referred to as the primary
table) can be returned in the report, regardless of their relationship to rows in the secondary table. Information in the
secondary table that is related to information in the primary table can also be returned. For example, if accounts is the
primary table and incidents is the secondary table in a report, it can return information about all sta accounts, whether
or not they have incidents assigned to them. The report can also return information about incidents that are assigned to
sta members, but cannot return information about incidents that are not assigned.

Since outer joins allow all data from the primary table to be returned, but only some from the secondary table, the
ordering of the tables is important when using outer joins. If your report does not return the information you want from
two tables that are outer joined, you may need to change which table is the primary and which is the secondary. See
Change Table Ordering.

Tip:  When using outer joins, it can be helpful to add a eld from the table you are most interested in rst. If
your report’s purpose is primarily to output information about contacts, a eld from the contacts table should
be added as a column before elds from other tables.

Outer joins are not automatically used in reports since inner joins meet the requirements of most reports and are
easier to process in database queries than outer joins. Outer joins are also referred to as left joins by those familiar with
database queries.

Related Topics
• How to Change Table Relationships

How to Specify Joins for Tables with Multiple Relationships  
You can specify the elds you want to use to join tables when the tables share more than one relationship.

Some tables are linked together in the database using more than one eld. For example, incidents can link to accounts
through three elds in the incidents table. When joining these tables, the link between the tables is not automatically
created, so you must dene which eld should be used to tie the tables together in the report. You’ll do this on the
Select Join window, which automatically opens when you add elds from tables such as this to the same report.

The Select Join window also appears if your report already has multiple tables and you add a eld from another table
that can be related to more than one of the tables already in the report. In this case, you must dene which table the
new table should be joined to, since dierent data can be returned by joining dierent tables. By default, the new table is
joined to the primary table in the report using an inner join.

An example that illustrates both cases is if your report includes the incidents and contacts tables, and you then add a
eld from the accounts table. The accounts table can link to the incidents table through three incident elds and can link
to the contacts table through one contact eld. In this instance, you would be asked if the accounts table should link to
incidents or contacts, and, if it is the incidents table, which eld in the incidents table should be used as the link.

Specify Fields to Link Tables  
In a report, you can link tables together in the database using more than one eld.

1. Add a column or lter to the report from a table that can be linked in more than one way to the other tables in
the report.
The Select Join window opens.
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2. To accept the default table relationship that is displayed, click OK.
3. To dene which tables should be linked, select the option next to the table that the new table should join to.

a. If the new table can link to the selected table by more than one eld, select the correct eld from the
drop-down menu that displays next to the table’s option.

The eld you join the new table to should be associated with the information you want to output
in the report. For example, if you’re joining the accounts table to the incidents table, select the
incidents.created_by => accounts.acct_id option to output information about the sta member who
originally created the incident. If you instead want to output information about the sta member the
incident is assigned to, select the incidents.assgn_acct_id => accounts.acct_id option.

4. To prevent the Select Join window from displaying again when editing the current report, select the Do Not
Show This Dialog Again check box. If you then add another eld that requires dening a table relationship, you
need to dene the relationship from the Data Set window. See Change Table Joins and Linked Fields.

5. If you do not want to dene a table relationship, click Cancel.
If you click the Cancel buon, the eld you added is still added to the report output, and the new table is added
to the report as another primary table. However, there will not be a relationship between this table and the
other tables in the report until you manually dene the relationship from the Data Set window. You will not be
able to save the report until you dene this relationship. See How to Change Table Relationships.

6. Click OK.

Dene Intermediate Table Joins  
Tables that are not directly linked together in the database can still be joined by going through intermediate tables that
are common to both.

If you aempt to use elds from two tables related to dierent areas of the application, it may not be possible to join
them using an intermediate table. In these instances, both tables will be considered primary tables in the report and
you will need to manually edit the table relationships before you can save the report. However, if you encounter this
scenario, we recommend reconsidering the report’s design since a single report is not intended to report on unrelated
information.

1. Add a column or lter to the report that requires an intermediate table join.
The Select Intermediate Table and Join window opens.

2. In the Join From column, select the option next to the table you want to join the new table to.
3. In the Intermediate Table column, select the option next to the table you want to use as the intermediate table

to join the new table with the table selected in the Join From column.
4. In the First Join column, click the drop-down menu and select the elds you want to join from the intermediate

table and the table selected in the Join From column.
5. In the Second Join column, click the drop-down menu and select the elds you want to join from the

intermediate table and the new table you’re adding.
The join tree you dene displays on the window.

6. To prevent the Select Intermediate Table and Join windows from displaying again when editing the current
report, select the Do Not Show This Dialog Again check box.
If you then add another eld that requires dening an intermediate table relationship, you need to dene the
relationship from the Data Set window.

7. Click OK.

Related Topics
• How to Change Table Relationships

• Change Table Joins and Linked Fields
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How to Add and Edit Charts  
You can add charts to your reports to provide the audience with graphical representations of the report’s data.

Using charts, you can clearly compare data or highlight trends or paerns in the data. For example, a pie chart could
show comparisons in the number of incidents assigned to sta accounts in the previous week, or you could use a bar
chart to show incident activity over a period of time.

You can manually add charts to reports, or you can use a chart table layout to automatically add generic charts with
precongured positions. You edit charts with the Chart Wizard, to select the chart type, the data used in the chart, labels
for the chart, and other seings. In addition, you can change the appearance of charts, including fonts, colors, and other
aributes.

Note:  Each report level can have a maximum of twenty charts.

Add a Chart Manually  
When you manually add a chart to a report, you can dene all the chart elements, determine how the chart should be
sized, and where it should be located in the report.

This procedure describes adding charts using the buons on the Insert tab. You can also add charts by selecting the
Charts report section, clicking the Options tab, and clicking Add Chart to open the Chart Wizard. See Add or Edit a Chart
with the Chart Wizard.

1. Open the report you want to edit.
2. If your report has multiple output levels, select the level you want to add the chart to from the Level drop-down

menu at the top of the design surface.
3. Click the Insert tab.

Buons for the types of charts you can add to the report are displayed on the tab’s Chart group.
4. Click the buon for the chart type you want to add and select the chart subtype you want to add to your report.

See Add or Edit a Chart with the Chart Wizard for descriptions of the available chart types.
5. Click the Charts report section to add the chart to the report.

The Chart Wizard opens.
6. Congure the chart and select a chart style with the Chart Wizard.

See Add or Edit a Chart with the Chart Wizard.

Note:  If you have applied a report style to the report, the chart style that is associated with the report
style is used by default. You can select a dierent chart style on the Chart Wizard or by clicking the
Chart Style buon on the Design tab. See Apply a Style to a Report.

7. Apply any custom style aributes you want for the chart from the ribbon’s Design, Layout, and Format tabs.
For information about the options available on these tabs, see Create or Edit a Chart Style.

8. To enable automatic positioning and sizing for your chart, edit style options for the chart’s report section.
See Chart Placement and Sizing.

9. Repeat all steps to add additional charts to your report.

Add a Chart Using Chart Layouts  
If you do not want to manually place charts in your report, you can add them using chart table layouts.
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When you use a layout, charts are automatically added to your report and are given optimal placement. In addition, the
charts are automatically sized in your report.

1. If the Charts report section is not displayed on the report level, click the Display tab and select the Charts check
box.

2. Click the Charts report section on the design surface to select it.
3. Click Automatic on the Options tab to apply automatic formaing to the report section. See Change the Display

of a Report Section.
4. Click Layouts to view chart section layouts.
5. Click one of the table layouts to apply it to the current output level. The table layout you select determines how

many blank charts are added to your report and how they are arranged.
6. Do one of the following:

◦ Right-click a blank chart on the design surface and select Edit Chart to congure the chart with the Chart
Wizard. See Add or Edit a Chart with the Chart Wizard.

◦ Select a chart on the design surface, click the Design tab, click Type, and select the chart type and
subtype you want to use.

The wizard opens automatically if the new chart type requires dierent source data than the previous chart
type.

7. To change data options for a chart type that does not require dierent source data, click Dene Data Source to
manually open the Chart Wizard.

Related Topics
• Chart Placement and Sizing

Add or Edit a Chart with the Chart Wizard  
You can use the Chart Wizard to create and customize charts for a report.

The Chart Wizard displays a series of windows for customizing charts. The rst window displays the list of available
chart types and subtypes. Each successive window contains additional options for customizing your chart. The available
options on each succeeding window depend on the chart type and subtype selected.

1. Add or edit a chart to open the Chart Wizard.

2. Click the Chart Type drop-down menu to select the chart type you want to use.

Chart Type Description

Vertical Bar Vertical bar charts display data as a series of vertical bars. Subtype options can display
the chart with single or stacked bars and as two- or three-dimensional.

Horizontal Bar Horizontal bar charts display data as a series of horizontal bars. Subtype options can
display the chart with single or stacked bars and as two- or three-dimensional.

Pie Pie charts display data as a percentage of a whole. Subtype options can display two- or
three-dimensional pie charts or doughnut charts.

Line Line charts display data as a series of points connected by a line. Subtype options can
display the chart as two- or three-dimensional.

Line/Bar Combo Line/bar combo charts display both a line chart and a vertical bar chart. Subtype
options can display the chart with single or stacked bars and as two- or three-
dimensional.
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Chart Type Description

Area Area charts display data as areas on an x- and y-axis. Subtype options can display the
chart as two- or three-dimensional.

X—Y X-Y charts display data as a series of ploed points. Subtype options can display the
ploed points as points, lines, or bubbles and as two- or three-dimensional.

Radar Radar charts display data in a radar format. Numeric values are ploed at markers on
the perimeter.

Stock Stock charts display the minimum and maximum values for data. Subtype options can
display the chart using squares or lines to represent the high and low points of each
plot.

Pareto Pareto charts display data in descending order with an ascending plot line for
cumulative percentage. Subtype options can display the chart as two- or three-
dimensional.

Gauge Gauge charts display a numeric value as a percentage of a whole. Subtype options can
display the chart as a gradation bar or a simple color meter.
 
Gauge charts cannot be used in reports that contain non-aggregate columns.
 

Funnel Funnel charts display data as areas shown in ascending or descending order. Subtype
options can display two- or three-dimensional funnel or pyramid charts.

Gan Gan charts display time lines for completion of scheduled tasks. Subtype options can
display the chart as two- or three-dimensional.

3. Select one of the chart subtypes from the Chart Subtype section.
4. Click Next to open the Source Data window.

The source data options let you specify the data to display in the chart. For example, if creating a vertical bar
chart, you can specify a column to use as the chart’s category value, displaying on the x-axis, and the column
to use as the chart’s series value, displaying on the y-axis. The wizard also displays a sample chart to help you
identify chart elements.

5. Enter eld information.

Field Description

Available Columns
 

This eld displays the columns you have added to the report level that can be used in
the chart.
 
If you have not yet added columns to the report, you can click this area to open the
Column Denition window. See Add a Column to a Report.
 

Add Column
 

Click this text to open the Column Denition window to add a column to your report
level. This option provides a method to add columns if your report level does not have
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Field Description

any columns or does not include a column you want to use for your chart. See Add a
Column to a Report.
 

Add a Column for the Category
Value
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as categories in
your chart. To remove a column, drag it back to the Available Columns section or select
the column and press Delete.
 
To move the column, click the up or down icons to move the column one position.
 
This option is not available for Pie, Gauge, and Funnel charts.
 

Add One or More Series
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as series in your
chart. To remove a column, drag it back to the Available Columns section or select the
column and press Delete. Only numeric columns can be used as series.
 
To move the column, click the up or down icons to move the column one position.
 
This option is not available for Gauge and Line/Bar Combo charts. In addition, Pie and
Funnel charts accept only one series.
 

Dene Series
 

This section allows you to manually choose the output columns or column values to use
for the series.
 
This section is not available for Pie, Line/Bar Combo, X-Y, Stock, Pareto, Gauge, and
Funnel chart types.
 

By Manually Selecting from
Available Columns
 

Select this option to manually select the columns used as values in the chart. For
example, if you were reporting on incident statistics for dierent products, you could
dene the category as “Products” and the series as “Unresolved Incidents” and “Solved
Incidents.” The category axis would display each product and the value axis would
display a list of values. Each product would have two bars: one for unresolved incidents
and one for solved incidents.
 

Using Values From
 

Select this option to choose the output column that is used to automatically populate
values for the series. For example, if you were reporting on incident statistics for
dierent products and assigned to dierent groups, you could dene the category as
“Products” and the series as “Unresolved Incidents.” If you selected groups from the
drop-down menu associated with this option, each group would be used as a bar chart
for each product. The category axis would display each product and the value axis
would display a list of values (unresolved incidents). Each product would have bars for
each group.
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Get Labels From
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as labels in your
chart. Labels represent each piece of the pie. To remove a column, drag it back to the
Available Columns section or select the column and press Delete.
 
This option is available only for Pie and Funnel charts.
 

Add Line Series
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as the line series
in your chart. To remove a column, drag it back to the Available Columns section or
select the column and press Delete. Only numeric columns can be used as series.
 
This option is available only for Line/Bar Combo charts.
 

Add Bar Series
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as the bar series in
your chart. To remove a column, drag it back to the Available Columns section or select
the column and press Delete. Only numeric columns can be used as series.
 
This option is available only for Line/Bar Combo charts.
 

Select Gauge Series
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as series in your
chart. To remove a column, drag it back to the Available Columns section or select the
column and press Delete. Only numeric columns can be used as series.
 
This option is available only for Gauge charts.
 

Select Line Series
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as the line series
in your chart. To remove a column, drag it back to the Available Columns section or
select the column and press Delete. Only numeric columns can be used as series.
 
This option is available only for X-Y charts with a combo subtype.
 

Add Bubble Series
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as the bubble
series in your chart. To remove a column, drag it back to the Available Columns section
or select the column and press Delete. Only numeric columns can be used as series.
 
This option is available only for X-Y charts with bubble or combo subtypes.
 

Add Bubble Values
 

Select one or more columns from Available Columns and either drag them or click the
arrow to move them to this grid. Columns added to this grid are used as bubble values in
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your chart. To remove a column, drag it back to the Available Columns section or select
the column and press Delete.
 
This option is available only for X-Y charts with bubble or combo subtypes.
 

Category Axis Series
 

Select a column to use as the category for the chart from this drop-down menu.
 
This option is available only for Gan charts.
 

Select Progress Series
 

Select a column to use as the progress series for the chart from this drop-down menu.
Only integer columns can be selected for the progress series.
 
This option is available only for Gan charts.
 

Select Start Date Series
 

Select a column to dene the start date series from this drop-down menu. Only date
columns can be selected for the start date series.
 
This option is available only for Gan charts.
 

Select End Date Series
 

Select a column to dene the end date series from this drop-down menu. Only date
columns can be selected for the start date series.
 
This option is available only for Gan charts.
 

6. Click Next to dene general chart seings.
7. Enter eld information.

Field Description

Chart Title
 

Enter the title of the chart in this text box.
 

Category Axis Label
 

Enter the label of the category axis in this text box.
 
This option is not available for Pie, Radar, Gauge, or Funnel charts.
 

Value Axis Label
 

Enter the label of the value axis in this text box.
 
This option is not available for Pie, Line/Bar Combo, Radar, Gauge, or Funnel charts.
 

Bar Value Axis Label
 

Enter the label for the chart’s bar value.
 
This option is available only for Line/Bar Combo charts.
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Line Value Axis Label
 

Enter the label for the chart’s line value.
 
This option is available only for Line/Bar Combo charts.
 

Sync Bar Line Scales
 

Select this check box to use the same range for the chart’s bar and line scales.
 
This option is available only for Line/Bar Combo charts.
 

Chart Style
 

Click the underlined text to select a chart style for the chart. The chart style you select
appears on the sample chart displayed on the Chart Wizard.
 
After you apply a chart style, you can customize the chart styling using buons on the
Design, Layout, and Format tabs. See Chart Styles Explorer.
 

Scale
 

Specify the scale used by the chart in this section.
 
This option is not available for Pie, Radar, or Funnel charts.
 

Default
 

Select this option to use the scale values specied in the selected chart style.
 

Custom
 

Select this option to dene a custom scale for the chart. For example, if the values listed
in a chart range from 10 to 50, you can create a custom scale to use these values as the
scale’s start and end points to prevent the chart from displaying ranges with no data.
 

Scale Start/Scale End
 

Enter the starting value (lowest value) and ending (highest value) for the chart’s scale in
these elds.
 
These options are enabled only when dening a custom scale.
 

Gauge Color Ranges
 

Add color ranges and dene range colors in this section. Color ranges can be used to
display numeric ranges in dierent colors. For example, a range of 0-33 could be green,
34-65 could be yellow, and 66-100 could be red.
 
This option is available only for Gauge charts.
 

Add Range
 

Click this text to add a color range.
 
A maximum of ve ranges can be shown on the gauge. The range values cannot contain
gaps or overlap.
 

Remove Range Click this text to remove a range you have added.
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Minimum/Maximum
 

Enter the starting and ending values for the range in these elds.
 

Start Color/End Color
 

Click these color boxes to select colors to indicate the start and end points of the range.
 

8. Click Finish.

You can edit or delete any chart you add by right-clicking the chart on the design surface and selecting the
appropriate option. You can also click the chart on the design surface and edit the chart with options available
on the Design, Layout, and Format tabs. See Create or Edit a Chart Style for information about the options on
these tabs.

Related Topics
• Add a Chart Manually

• Add a Chart Using Chart Layouts

Chart Placement and Sizing  
The Charts report section can be congured to use automatic or manual section layouts.

Each type of layout for the report section aects the display of data in your charts. When the Charts section has a
manual layout, you can select a chart on the report section and drag it to reposition it. You can also select a chart and
drag the handles on the chart’s outline to resize the chart. When you specify a specic chart size using a manual layout,
the data displayed on the chart is adjusted to t the chart. A large chart displaying a small amount of data may appear
too large. Also, a small chart displaying a large amount of data can be dicult to read since the data is compressed to t
the chart.

However, when using an automatic section layout, charts you add are automatically sized to best display the
data initially presented in the charts. In addition, when you adjust the report’s search parameters, the charts are
automatically resized to ensure that all the data is clearly displayed. For example, if your chart shows incidents created
over a date interval, and the report’s interval is adjusted to a longer period, the chart automatically expands to clearly
display all the additional intervals shown in the report.

Related Topics
• Change the Display of a Report Section

Overview of Report Filters  
You add lters to a report to limit the data the report returns.

If lters were not used, a report that included information from a table would return all the records in that table every
time you run the report. Some lters set hard limits on what the report can return, and other lters can be selected when
you run the report so you can look at dierent records. Filters also help improve report performance by preventing the
report from examining data you do not want included in the report.
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You can restrict the data returned in a report using the following lters.

• Report xed lters—Fixed lters restrict the data the report can access. Fixed lters cannot be changed or
edited when the report is run. See Create a Fixed or Runtime Selectable Filter.

• Report runtime selectable lters—Runtime lter values can be changed from their default values when running
a report. This lets you run the report to view data about records that share the values selected in the lter and
then immediately run the report again with dierent values selected in the lter. See Create a Fixed or Runtime
Selectable Filter.

• Level lters—Level lters are xed or runtime selectable lters that limit data at the individual output levels.
Level lters can restrict data from appearing in one level, while allowing it to be returned in other levels in the
same report. See Create a Level Filter.

• Group lters—Group lters are applied to an output level’s grouped data to lter out certain groups from
displaying in the report level’s output. See Create a Group Filter.

• Join lters—Join lters restrict data returned in the secondary table of outer table joins. See How to Create Join
Filters.

Tip:  Each report can have up to 100 report lters and each output level in a report can have 100 level lters
and one hundred group lters.

Create a Fixed or Runtime Selectable Filter  
Report lters limit the data that can be returned in any level of a report.

Report lters can be xed or runtime selectable. These lters are similar in that both restrict the data that is returned in
the report according to what the lter allows and are created in the same way. However, runtime lters can be changed
when the report is run, whereas xed lters cannot.

Runtime lters values can be changed by anyone viewing the report, either from the Search window or from docked
lters, to return dierent data each time someone runs the report. Fixed lter values cannot be changed when the
report is run, which allows you to restrict the data that report users can view.

Most reports used on workspaces automatically aempt to lter on the record shown in the workspace to display only
information that is related to the record. For this reason, when creating reports for use on workspaces, we recommend
including a lter based on the unique identier for the primary type of record shown in the workspace. For example, a
report used on an incident workspace could lter on the incident ID eld (incidents.i_id).

1. Open the report you want to edit.
2. Click the Home tab.
3. Click Add Filter.
4. Enter eld information.

Field Description

Name
 

Enter a name for the lter in this eld. The name identies the lter on the report
designer but does not display when the report is run. Entering a value for this eld is
optional. If a name is not entered, the name defaults to the name of the lter’s database
eld.
 

Make This Filter Selectable at
runtime

Select this check box to make the eld a runtime selectable lter. If this check box is
cleared, the lter becomes a xed lter.
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Field Description

   

Label This Filter
 

Enter a label for the lter in this text eld. This label displays on the Search window
when the report is run.
 

Required
 

Select this check box to require the report’s user to enter a value for the lter when
running the report. If this option is selected, the Search window opens automatically
when the report is opened and the lter’s value must be specied before results are
returned.
 

Expression*
 

Enter the expression you want to use for the lter in this eld. You can right-click
to select from a list of database tables, elds, and functions, or you can enter the
expression. A menu displays when you start entering text that lists the database tables
that begin with the leers you enter. You can either continue typing the expression
or select a table and eld from the list. For descriptions of the types of columns and
functions you can use in the expression, see Add a Column to a Report.
 
The maximum number of characters allowed in the expression eld is 3,500. You can
use replacement variables to create expressions that require more characters. See Add
Report Variables.
 
Only indexed database elds are available for use in lters.
 

Use Data Dictionary
 

Click this text to open a window containing the data dictionary tree where you can select
elds, functions, and variables for the expression.
 

Operator
 

Select the operator to use with the expression. The available operators vary depending
on the type of eld used in the expression. See Overview of Filter Operators for
descriptions of operators.
 

Value
 

Enter the value for the lter. If you’re creating a runtime lter, this value is the lter’s
default value that can be changed when the report is run. If you’re creating a xed lter,
 this is the lter value the report uses when it is run.
 
The available options in the Value eld change depending on the type of eld and the
operator you select. For example, a menu eld’s values display in a drop-down menu,
whereas a date eld’s values display date and time options. Text area elds are not
available for use in report lters.
 

Customize
 

Click this text when using In List or Not in List operators with menu elds to select menu
options you want displayed to the report’s audience. See Change Menu Filter Options.
 

5. Click OK.
6. Click Save on the Quick Access toolbar.
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Change Menu Filter Options  
You can hide selected report runtime lter menu options.

In some instances, you may have runtime lters that display a large number of menu options. If the sta members using
the report do not need to see all the menu options, you can hide the ones that are irrelevant to them to make it easier
to navigate the menu list. For example, if an incidents report includes a lter on the assigned group, and some sta
members don’t need to see incidents assigned to particular groups, you can hide those groups in the lter.

Tip:  If you need a report to display dierent menu options to dierent audiences, create a copy of the original
report for each audience and choose the menu options you want in each of the new reports. You can then
specify which proles have permission to open each report. See Copy Analytics Content and Set Report
Permissions.

1. Open the report on the report designer.
2. Click Filters on the Home tab.

The Edit Logical Expression window opens.
3. Select the lter you want to customize, and select Edit Filter.

The Edit Filter window opens, displaying the lter details.
4. Click Customize.

The Customize Filter Values window opens.
5. Clear the check boxes next to the menu options you do not want to display.
6. Click OK.
7. Click OK to close the Edit Filter window.
8. Click OK to close the Edit Logical Expression window.
9. Click Save on the Quick Access toolbar.

Create a Level Filter  
Level lters are similar to the lters that are applied to the main report.

While report lters are applied to the report as a whole, restricting the data that is returned at any level in the report,
level lters are applied to individual output levels and only restrict the data returned at the level where they are created.
If the report has multiple output levels, the other levels are not subject to the level lters applied to other levels in the
report.

1. Open the report you want to edit.
2. Select the level you want to add the lter to from the Level drop-down menu at the top of the design surface.
3. Click the Level tab.
4. Click Add Level Filter.

The Add Filter window opens.
5. Enter eld information described in Create a Fixed or Runtime Selectable Filter.
6. Click OK.
7. Click Save on the Quick Access toolbar.

Create a Group Filter  
Group lters can be used in output levels with grouped data to prevent rows with a certain number of grouped items
from displaying.
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For example, an output level that returns rows showing the number of unresolved incidents for each sta member could
have a group lter to display only rows for sta members with more than ten unresolved incidents. Group lters can be
xed or runtime selectable.

1. Open the report you want to edit.
2. Select the level you want to add the lter to from the Level drop-down menu at the top of the design surface.
3. Click the Level tab.
4. Click Add Group Filter.

The Add Filter window opens.
5. Enter eld information described in Create a Fixed or Runtime Selectable Filter.

Note:  The lter options for group lters are identical to those for lters applied to the overall report.
However, you generally want group lters to lter on the results in the output level’s aggregate column.
For example, if the aggregate column in your report counts the number of unresolved incidents a sta
member has with count (incidents.i_id), then the group lter’s expression could be count (incidents.i_id)
> 10, to return rows for sta members with more than ten incidents.

6. Click OK.
7. Click Save on the Quick Access toolbar.

Overview of Filter Operators  
The operator you select when creating lters greatly impacts the data that is returned, so it is important to understand
the functionality of each operator.

The types of operators available for a lter depend on the data type of the lter’s expression.

Operator Description

equals
 

The expression matches the value exactly, including case.
 
When using this operator with menu elds, you can quickly locate the menu item you want by entering
the rst few characters of the item’s name. Menu items that do not start with the text you type are
removed from the list.
 

not equals (exclude No Value)
 

The expression does not match the value exactly, including case. This operator excludes any values of
No Value (Null). For example, a report with a lter of eld  X not equals (exclude No Value) Y
cannot return any records with a value of Y or No Value in eld X.
 
When using this operator with menu elds, you can quickly locate the menu item you want by entering
the rst few characters of the item’s name. Menu items that do not start with the text you type are
removed from the list.
 

not equals (include No Value)
 

The expression does not exactly match the value, or is No Value (Null). For example, a report with a
lter of field X not equals (include No Value) Y cannot return records with a value of Y,
 but does return records with a value of No Value.
 
When using this operator with menu elds, you can quickly locate the menu item you want by entering
the rst few characters of the item’s name. Menu items that do not start with the text you type are
removed from the list.
 

less than
 

The expression is less than the value.
 

less than or equals
 

The expression is less than or equal to the value.
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Operator Description

greater than
 

The expression is greater than the value.
 

greater than or equals
 

The expression is greater than or equal to the value.
 

between
 

The expression is between two specied values. The between operator is available to use with date,
 currency, and numeric (integer and oat) expressions.
 
When using this operator with a date expression, records matching the beginning value’s date and time
are returned, but those matching the ending value’s date and time are not. This prevents records from
being displayed twice on a report that is run once to view records created between 9:00 AM and 10:00
AM, and run again to view records created between 10:00 AM and 11:00 AM, for example.
 

like
 

The expression matches any part of the value. When using the Like operator, you should use the %
wildcard symbol to oset your value. For example, if you were looking for all elds that contain “all,”
you should type %all% in the eld.
 

not like
 

The expression does not match any part of the value. Wildcard characters are supported.
 

not like or null
 

The expression does not match any part of the value, or is a null value.
 
This operator is not available in runtime selectable lters.
 

in list
 

The expression values you want to search for are specied by selecting check boxes in a menu. The
selected options are displayed in a separate Selected Items list to assist you when selecting from
menus with a large number of options.
 
When using this operator with menu elds, you can quickly locate the menu item you want by entering
the rst few leers of the value you want in the lter’s Search Text eld. To view the menu options you
have selected from a long menu list, click the splier bar to the right of the list.
 
When using this operator with integer elds, the numbers in the Value eld must be comma-separated.
When using this operator with text elds, the text strings in the Value eld must be comma-separated
and each text string must be oset by single quotes (for example, ‘red’,’green’,’orange’). Spaces
between entries are ignored.
 

not in list
 

The expression values you do not want to search for are specied by selecting check boxes in a menu.
The selected options are displayed in a separate Selected Items list to assist you when selecting from
menus with a large number of options. This operator is available only with menu eld expressions.
 
When using this operator with menu elds, you can quickly locate the menu item you want by entering
the rst few leers of the value you want in the lter’s Search Text eld. To view the menu options you
have selected from a long menu list, click the splier bar to the right of the list.
 
When using this operator with integer elds, the numbers in the Value eld must be comma-separated.
When using this operator with text elds, the text strings in the Value eld must be comma-separated
and each text string must be oset by single quotes (for example, ‘red’,’green’,’orange’). Spaces
between entries are ignored.
 

is null
 

The expression has a null value.
 
This operator is not available in runtime selectable lters.
 

is not null The expression does not have a null value.
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Operator Description

   
This operator is not available in runtime selectable lters.
 

Complex Expression
 

The expression matches any part of the value. This operator allows wildcard searching using an
asterisk (*) at the end of a word or partial word and a tilde (~) before a word to perform a similar
phrases search on that word only. See Search for a Record from a Report.
 

Not Complex Expression
 

The expression does not match the complex expression in the value. The Not Complex Expression
operator is available only with text eld expressions.
 

Edit a Logical Expression  
You can modify the logical expressions that join lters in a report.

When you add multiple xed or runtime lters at the same level in a report, the lters are automatically joined together
with a logical expression. This denes how the lters should work together to return data. By default, the logical
expression uses Boolean AND logic rather than OR logic. If you have a lter of incidents.status_id = Solved and a lter
of incidents.queue_id = Queue A, the logical expression is incidents.status_id = Solved AND incidents.queue_id = Queue
A.This expression would result in the report returning only solved incidents that are in Queue A.

If the default logical expression does not suit your needs, you can modify the expression from the Edit Logical
Expression window. You can also delete, edit, and add lters from this window if you decide your existing lters need
to be changed while editing the logical expression. Report lters, level lters, and group lters are joined with separate
logical expressions, though each expression is edited in the same manner.

1. Open the report you want to edit.
2. Open the Edit Logical Expression window for the report lters, level lters, or group lters, depending on the

type of lters you want to change the expression for.

◦ To open the Edit Logical Expression window for report lters, click Filters on the ribbon’s Home tab.

◦ To open the Edit Logical Expression window for level lters or group lters, select the report level you
want from the Level drop-down menu at the top of the design surface. Click the Level tab and then click
the Level Filters or Group Filters buon.

When you add lters, they are automatically joined with AND logic and display in an AND tree. runtime
selectable lters are displayed in the tree along with xed lters, which have an icon displaying a lock.

3. To add a lter joined with OR logic to the logical expression.
a. Click Add OR Node.

The node is added to the logical expression.

b. Click the lter that should be joined with OR logic and drag it to the new OR node.

When you add nodes to the expression, the nodes are displayed in a tree structure, with lters displayed either
in an AND node or an OR node. Filters in the same AND node are joined to each other using AND logic. Filters in
the same OR node are joined to each other using OR logic.

4. To negate a lter, select the lter and click Negate Filter. To negate a node in the expression, select the node
and click Negate Expression.

A negated lter or node displays on the Edit Logical Expression window with an exclamation mark. Negated
lters and nodes add NOT logic to the lter. For example, if your lter is incidents.status_id=Solved and you
negate the lter, the lter becomes incidents.status_id NOT=Solved.
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5. To add a new lter, select the node you want to add the lter to and click Add Filter. See Create a Fixed or
Runtime Selectable Filter.

6. To edit a lter, select the lter you want to edit and click Edit Filter. See Create a Fixed or Runtime Selectable
Filter for information about editing lters.

7. To delete a lter, select the lter you want to remove and click Delete Filter.

Note:  If the lter you delete uses a table that is no longer needed in the report, you should remove the
table from the report to help the report run eciently. See Change Table Joins and Linked Fields.

8. To display the lters’ eld denitions rather than their names, click Display Filter Descriptions.
The Edit Logical Expression window is updated to display the lters’ denitions. To display the lters’ names
again, click Display Filter Names.

9. To view a text denition of the current lters’ logical expression, click View Text Denition.
10. Click OK.
11. Click OK.
12. Click Save on the Quick Access toolbar.

Combine Runtime Selectable Filters  
When your report includes multiple runtime selectable lters that expect the same type of search input, you can
combine the lters to display a single search eld on the report’s Search window or docked lters.

This lets report users enter one search value to search by two or more lters simultaneously. For example, you could
have one search eld to search by contacts’ rst names, last names, and organizations’ names.

The combined lters can be joined using AND or OR logical expressions. Using AND logic, the search value you enter
must match values in all the combined elds to return results. Using OR logic, the search value you enter needs to
match a value in only one of the combined elds. By default, lters are joined using AND logic. See Edit a Logical
Expression.

Runtime selectable lters that have the same data type, operator, and search options, such as items in a menu eld, can
be combined. You can combine multiple report lters and multiple level lters, though you cannot combine report lters
with level lters.

1. Create a runtime selectable lter. See Create a Fixed or Runtime Selectable Filter.
2. Create a second runtime selectable lter.

This lter must have the same name as the other lter you are combining. In addition, the two lters must use
the same operator and must be of the same data type. For example, you can combine two integer elds, but
you cannot combine an integer eld with a menu eld.

Add Variables or Runtime Filters to Docked Filters  
Variables and runtime lters can be added to docked lters to make them easier to access when viewing reports.

Report users can change variable and lter values using the Search window. However, they can also be added to an
output level’s docked lters.

1. Open the report you want to edit.
2. Click the Home tab.
3. Click the arrow on the Views buon and select Data Set View.

Using the data set view, you can see every lter and variable in your report, and you can select them on the
design surface for editing.

4. Click a lter or variable on the design surface.
5. Click the Design tab.
6. Select the Display in Docked Filters check box.

You can double-click docked lters and variables shown on the design surface to open them for editing.
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7. Click Save on the Quick Access toolbar.

When you run your report or view it using a dierent view, the lters and variables you selected in the Docked Filters
report section display at the top of the report.

Overview of the Search Window  
The Search window you use to search for information in a report or dashboard displays the lters and variables you
specify. You can place these where you want, and size the window to suit your needs.

By default, the controls for the lters and variables have xed sizes and are grouped by the type of input eld they use.
For instance, lters for text elds are grouped together as are lters for menu elds. The contents of each group are
further arranged according to the operators used by each eld in the group. The controls on a dashboard’s Search
window are also grouped by the items common to all reports on the dashboard, and those that are specic to individual
reports (see How You Search Dashboard Reports).

If the default layout of your report’s Search window does not meet your needs, you can size and organize the window’s
contents to ensure that they display as you want them to. For example, you can place the lters you regularly use before
the lters with default values you seldom change. In addition, you can manage whitespace on the window by stacking
smaller lters and wrapping date range lters.

When you customize a Search window layout from the report or dashboard designer, the layout you save is used as the
default layout for all users of the report or dashboard. However, they can also customize the layout and then save it to
their local workstation so they see the same layout when they next open the report or dashboard.

Note:  If you dene a custom layout for a report that is later modied on the report designer, any changes
made to the report will not overwrite the layout you dene. If new lters are added to the report, they will
display last in the user’s customized layout, and any lters deleted from the report will disappear from the
layout.

Related Topics
• Modify the Search Window

Modify the Search Window  
You can customize the Search window you use to search for information in a report or dashboard.

1. Open the search designer.

◦ To open the search designer when viewing a report or dashboard, open the Search window and click the
gear icon next to Seings in the lower left of the window. See How You Search in Reports and How You
Search Dashboard Reports.

Or

Click Seings and select Enter Search Design Mode.

◦ To open the search designer when editing a report, add the lters you want to the report, click the arrow
on the Home tab’s Filters buon, and select Search Designer.

Or

Click the arrow on the Home tab’s Filters buon to open the Edit Logical Expression window and click
Search Designer.

◦ To open the search designer when editing a dashboard, click Parameters Values and click the gear icon
next to Seings. Dashboard lters are grouped by lters common to multiple reports and lters unique to
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individual reports. When conguring the search layout for a dashboard, you cannot move lters between
the groups.

2. To move a lter, hover over it. The active lter is outlined and the cursor displays as positioning arrows. Drag
the lter to the position you want. Blue indicators display, showing you where the lter will be placed.

3. To resize a lter, hover over a border of the lter and then drag the border until the lter is sized as you want.
4. To stack two or more lters together so you can move or resize them together, drag one of the lters

immediately below another. An icon displays at the boom of the stack, as shown in the following gure.

To move the stacked lters as a group, click the icon and then drag the lters where you want.
5. To save the layout you congured when editing a report or dashboard, click Set as Default Layout for All

Users.
The search designer closes. After you save the report or dashboard, the layout is saved to the report’s or
dashboard’s denition.

6. To save the layout you congured for a report or dashboard you’re viewing, click Set as Default Layout.
The search designer closes and the layout you congured is saved to your workstation.

Related Topics
• Overview of the Search Window

How to Create Join Filters  
Join lters lter data in tables that are joined to the primary table with an outer join.

Join lters are xed and cannot be changed when the report is run. Join lters are similar to report lters in that they set
restrictions on the records that can be returned by the report, but they apply to the table join rather than to the data that
is returned by the query on the database. Join lters limit the data contained in the secondary table of the table join.
Without join lters, there would be no way to add a report lter to limit returned data from the secondary table, while
not preventing data from the primary table from being returned.

Note:  From an SQL perspective, join lters are a condition of the ON clause, whereas report lters are a
condition of the WHERE clause.

For instance, suppose you want your report to return a list of organizations and the number of incidents they have
opened before January 1st. You also want to return any organizations even if they have not submied any incidents,
so you need to join the incidents table to the organizations table with an outer join. Using an inner join would prevent
organizations that have no associated incidents from being returned in the report. You would then add a join lter of
incidents.created < January 1st. If you also wanted incidents created after March 1st, you would add an OR join lter
of incidents.created > March 1st to the rst lter. The resulting join lters denition would be incidents.created <
January 1st OR incidents.created > March 1st.

The method of adding join lters is similar to that for adding report lters. However, unlike report lters, join lters allow
you to use either a constant value, as report lters do, or an expression you create from the database elds and the
functions. See Functions for Reports for function descriptions.

Related Topics
• Create a Join Filter
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Create a Join Filter  
You can create join lters to lter data in tables that are joined to the primary table with an outer join. Tables joined with
an inner join do not have the Join Filters option.

1. Click the Home tab while editing a report that has multiple tables.
2. Click Tables.
3. Select the table you want to add a join lter to.
4. Click Join Filters.

The Data Set window displays the Join Filters section.
5. Click Add Filter.

The Add Filter window opens.
6. Do one of the following:

◦ Enter the expression for the join lter.

◦ Click Use Data Dictionary to open the data dictionary where you can dene the lter’s expression.

7. To use an expression lter value, select the Expression option.
The Add Filter window then displays a Value eld.

8. Do one of the following.

◦ Enter the expression in the Value eld.

◦ Click Use Data Dictionary to open the Edit Expression window, from which you can create the value’s
expression using database elds, functions, and variables listed in the data dictionary.

Note:  Currency elds are not available for use in join lters.

9. Click OK.

After you add a join lter, the Data Set window is updated to display the lter, along with additional actions that are
identical to those used when creating logical expressions for report, group, and level lters. These actions let you edit
your lter, create additional lters, add OR logic to the join lters, negate lters, view a text denition of the join lters’
logical expression, and switch between the lters’ descriptions and names. See Edit a Logical Expression.

Related Topics
• How to Create Join Filters

Overview of Report Output Levels  
After you congure the primary output level in your report, you can add output levels, also referred to as drill-down
levels, that contain details about records in the rst level.

Report users access these secondary levels by clicking on records in the rst level that act as links. This is congured in
the report designer by grouping data in the primary output level, then creating a drill-down level with more information
about the group’s data. You can have up to fty drill-down levels in your report which can be linked to from the same
output level or from sub-levels of the primary output level. See Drilling Down in Reports.

For example, you could create a report listing all unresolved incidents in your knowledge base grouped by the queue
they are associated with. The report’s rst output level could display every queue and the number of unresolved
incidents in the queue. You could then create a second output level to display incident details when drilling down on a
queue’s name, or on the number of unresolved incidents in the queue.
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Each output level you add to a report can have its own headers, footers, charts, data exceptions, custom scripts, and
other standard elements. These are congured in the same way as those on the primary output level.

You can also create drill-down functionality in reports by linking reports together. This method is used when the
separate levels contain disparate information pulled from dierent database tables. See Overview of Linked Reports.

Group Data in an Output Level  
Grouping data in an output level allows you to combine records with similar data into one row.

Output levels with grouped data often have other output levels added to them. This lets you drill down into another
output level to view details about the grouped records. When you group data, you can order the grouped columns to
best suit your needs when you create drill-down output levels.

When you add an aggregate column to an output level, grouping is automatically enabled in the output level. For
example, if you were to add a column with an expression of count(incidents.i_id) to an output level to see how many
incidents a contact has, the output level would automatically be grouped since you’re using a function to group records
together in the column.

1. Open the report you want to edit.
2. Select the output level you want to edit from the Level drop-down menu at the top of the design surface.
3. Click the Level tab.
4. Click Edit.

The Level Seings window opens.
5. Select the Group Results check box.
6. Click OK.
7. Click Save on the Quick Access toolbar.

Change Data Grouping Order  
When data is grouped in a level, it is automatically grouped in the order in which the columns are listed in the output
level. This impacts the ordering of lters on drill-down levels that you add to a report. You can manually change group
ordering if you need to.

The ordering of grouped data doesn’t aect the rows displayed in the grouped output level. It instead aects the
ordering of the drill-down lters of the output level that you drill down into. This ordering is important since it impacts
what records you can see when drilling down into the level.

You want the list of elds to start with a eld that stores values that multiple records can share so the records can
be grouped together by the eld’s value. For instance, grouping records by incident status works well since multiple
incidents have the same status. You would not want a unique eld that stores unique values listed rst in the drill-down
lters. For instance, grouping by incident reference number does not work since the reference number is dierent for
every incident.

For example, if you have a report with columns for Reference #, Subject, and Status Type, in that order, the output
level’s data are also grouped in that order. If you then add a drill-down level, the elds in the drill-down menu’s Filter
menu would be listed in this order.

• incidents.ref_no

• incidents.ref_no, incidents.subject

• incidents.ref_no, incidents.subject, incidents.status_id
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Since incidents.ref_no is the rst ordering eld for a drill-down level, the drill-down level would return only information
related to the incident you drilled down on. If you wanted to drill down on all incidents grouped by a dierent eld, such
as the incidents’ status, you would need to reorder the grouping so incidents.status_id is grouped rst.

1. Select the Group Results check box on the Level Seings window.
See Group Data in an Output Level.

2. Click Change Group Order.
The Dene Group Order window opens and is populated with the columns included in the output level.

3. Select the eld in the list that you want to move.
4. To move the eld higher in the list, click the up arrow.
5. To move the eld lower in the list, click the down arrow.
6. Click OK.

Create an Additional Output Level  
You can add a drill-down output level in a report to display only the content you want.

After you congure your primary output level, adding a drill-down output level is simple, requiring only that you identify
the column to lter on and the column(s) to link from in the parent output level. By default, the new output level displays
the same report sections shown on the parent level, such as the charts and data area sections, though you can select
the sections to display on the new level from the ribbon. You can add content such as text elds, charts, and columns to
the new output level just as you did in the primary output level.

1. Open the report you want to edit.
2. Select the parent level you want to add the new output level to from the Level drop-down menu at the top of

the design surface.
3. Click the Level tab.
4. Click Add Drilldown to open the Level Seings window with drill-down options.
5. Enter eld information.

Field Description

Name
 

Enter the name of the new level in this text box.
 

Description
 

To add an optional description for the output level, enter the description you want in
this text box. The description displays in the level’s Output Descriptions section. See
Remove Search Criteria Descriptions.
 

Group Results
 

This check box is not used when initially creating new output levels. See Group Data in
an Output Level.
 

Drill-Down Seings
 

This section denes the data and the link in the parent output level you use to open the
drill-down output level.
 

Filter
 

Click this drop-down menu to select the output column or columns to use as the lter
for the new level. The drill-down lter determines the data set displayed in the drill-
down level.
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Field Description

Link
 

Click this drop-down menu to select the output column that you click to open the drill-
down level. You can also select Entire Row to open the drill-down level by clicking
anywhere on a row in the parent output level.
 
If you want to drill down into another report level instead of opening a specic record
when a value from the record is double-clicked on a report, select Entire Row as the
drill-down link. When conguring record commands for the report, select None from
the Default Record drop-down menu. See Change Record Command Actions.
 

Display Report Level in Split Window
 

Select this check box to open the drill-down output level in a split window on the
content pane. This results in the parent output level remaining visible on the other part
of the content pane.
 

Window Location
 

When you select the Display Report Level in Split Window check box, you can then
select the position where the split window should open. Click this drop-down menu to
select Top, Boom, Left, or Right.
 

Custom Script
 

This section allows you to create, edit, and remove custom scripts to modify the output
level’s output. See Create a Custom Script in a Report.
 

Add
 

Click this text to add a custom script to the output level.
 

Edit
 

Click this text to edit an existing custom script.
 
This option is available only when a custom script has been added to the output level.
 

Remove
 

Click this text to delete an existing custom script.
 
This option is available only when a custom script has been added to the output level.
 

6. Click OK.
7. Click Save on the Quick Access toolbar.

Congure Recursive Drill-Down Levels  
You can drill down recursively on hierarchical items (for example, accounts, products, and categories) in a report.

Recursive drill-down allows you to start at specied levels of a hierarchy and become more specic at each lower level
as you drill down into it. This feature enables automatic links for hierarchical items so you can access additional levels of
detail when viewing a report.

You can enable recursive drill-down only for a level that has a hierarchical output column. If an output level has a
hierarchical output column and you do not enable recursive drill-down for the level, then only data for the output
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column’s rst level can be displayed. A level can have both regular and recursive drill-down enabled, but the drill-down
links cannot be the same.

1. Create a report output column from a hierarchical item (for example, accounts.hierarchy or
incidents.prod_hierarchy).

2. Click the Level tab and click Edit.
The Level Seings window opens with recursive drill-down options.
The recursive drill-down feature is automatically enabled. To disable the feature, clear the Enable Recursive
Drilldown check box.

3. Click the Starting Level drop-down menu and select the starting point for the drill-down level.
For example, starting level 1 would be the top product in your list of products. Starting level 3 would be three
subproducts down from the parent product.

4. Click the Link drop-down menu and select the output column you want as the drill-down link in the report.
By default, this is the hierarchical item.

5. Click OK.

Create a Custom Script in a Report  
You can add custom PHP scripts to your output levels to further manipulate the data in your report. For example,
custom scripts can remove unwanted data, create links to web pages, and convert rows of data into tables.

When a report with a custom script runs, the report rst runs on the server, then the script is applied to the report’s
output. It is important to consider this ordering when creating custom scripts since this may cause the script to not
function as you expect. For instance, when you view a report with a script that hides certain rows, the total number of
records and pages on the report may be greater than what you see on the report, since these totals are generated when
the report rst runs.

PHP scripting language must be used when dening a custom script. PHP is a free, open-source scripting language
and interpreter, similar in many ways to JavaScript and Microsoft’s VBScript. Like other scripting languages, PHP allows
server-side scripting to be embedded inside client scripting. We recommend that you do not aempt to create custom
scripts unless you’re familiar with the PHP language and programming concepts. For documentation and information,
see the  ocial PHP site .

Note:  Custom scripts cannot include direct SQL statements.

1. Open the report you want to edit.
2. Select the output level you want to add the custom script to from the Level drop-down menu at the top of the

report designer.
3. Click the Level tab.
4. Click Custom Scripts. The Custom Script editor opens.

If the output level already has a custom script, the editor displays the custom script for editing.
5. From the Initialization tab, enter the script executed before the report is processed.

This script is executed when the report starts to process.

Note:  If the report is to be scheduled (see How You Schedule Reports), add
putenv('TEMPORARY_RNW_CONF_DIRECTORY'); to the Initialization pane to ensure the custom script runs
correctly when recipients open the report.
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6. Click the Headers tab.
7. Enter the script that runs during the start process.

This script is called once while passing the column headings. The $headers parameter is an array that contains
the column headers for the report. For example:
 Array
 (
 [0] => Account ID
 [1] => Full Name
 )

8. Click the Process tab.
9. Enter the script that runs while the report is generating.

This script is called with each row passing the row data. The $rows parameter is a nested array, allowing you to
return a “table” of data rather than just a row. Initially, the $rows parameter contains only data in the rst row of
the table ($rows[0] [$i]). Each data cell contains a val variable that holds the value of the data cell. It can also
contain a URL variable that contains a link for the data cell.

10. Click the Finish tab.
11. Enter the script that runs during the exit process.

This script is called after the rows have been processed. The Finish script returns data in the $exit_obj variable,
which is added to the report after each row of the Process script.

12. Click OK to apply your custom script to your output level.
13. To remove a custom script, click the Level tab, click Edit, and click Remove. Click Yes to the removal

conrmation.
14. To check the custom script for PHP errors, click the Home tab, click Views, and select either Report View or

Layout View.
If errors are found in the PHP code, a message displays. You can save the report if the message shows an error,
but the custom script will be disabled when you run the report. When the problem is corrected and the report is
saved again, the custom script will be enabled.

15. Click Save on the Quick Access toolbar.

After adding a custom script to an output level, we recommend previewing the report using the Report View and Layout
View options on the Home tab’s Views buon. When you do so, the custom script is checked for errors and a message
displays if any are found. When troubleshooting reports, we also recommend that you check if any of the report’s output
levels have custom scripts since these can modify the reports’ appearance and functionality.

Overview of Linked Reports  
You can use conditional and unconditional links to link reports together.

Before you create report links, you should be familiar with the variables and runtime selectable lters in the reports or
dashboards you’re linking to since you dene the values you want to use for these every time you create a report link. In
addition, you should know whether you want to use unconditional or conditional links.

• Unconditional links—You can use an unconditional link to open a specic report or dashboard when you
drill down on any value in the parent report’s linked column. The content in the linked report or dashboard
vary depending on the report’s variables and lters and the value you drill down on, but the same report or
dashboard is linked to regardless of the value selected in the parent report’s column. This functionality is similar
to drilling down on a value in a column to open another report level.

• Conditional links—You can use conditional links to open dierent reports or dashboards depending on the
value you drill down on in the parent report’s linked column. For example, if a column in your parent report
lists contacts’ SLAs (service level agreements), you could add a conditional link for each unique SLA listed in
the column. When you click one of the SLAs in the column, a report that shows information specic to that
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SLA would open. Just as with unconditional links, the content in the linked reports or dashboards can vary
depending on the values you specify for the linked reports’ variables and lters.

You create links using the Report Linking wizard or the Conditional Report Linking wizard. The wizards are similar,
though the Conditional Report Linking wizard includes an additional step. In addition, the ordering of conditional links is
important.

Just as you can drill down into dierent levels within a report (see Overview of Report Output Levels), you can also drill
down into separate reports or dashboards using report linking. This helps avoid database query limitations since linked
reports run independently of one another. Using linked reports is also benecial when you need to create multiple
reports with identical drill-down levels, since you can create a single report and link to it from multiple reports instead of
re-creating identical levels in multiple reports. See How to Use Linked Reports.

Additionally, if you have very complex reports that aempt to display columns with summaries of data from several
tables, you may want to use inline aggregate reporting for more ecient database queries. See Inline Aggregate
Reporting.

How to Use Linked Reports  
While report links are easy to use, there are some items you’ll want to consider before adding them to reports.

When a report link is created, it is applied to a specic column in the parent report. When you click the link in the
column, the linked report opens on a new tab, an existing tab, or on the same tab as the parent report in a split window,
depending on how the report link is congured. You close a linked report or dashboard by closing the tab or clicking the
Top Level link in the report.

Since report links are specic to columns, you can have several links to reports and dashboards in the same report. Your
report can also include drill-down links to other levels in the same report. Report links can be added to any of the output
levels in the parent report, allowing you to link to a large number of reports and dashboards from one report.

While report links are easy to use, there are some considerations before adding them to reports.

• Report links function normally when they are added to workspaces, but the links are unavailable if the reports
are used in workspace relationship items. See Overview of Workspace and Script Elements for information
about using reports in workspaces.

• Just as with drill-down links to other report levels, report links are unavailable when a report is forwarded,
exported, published, or sent as a scheduled report. See How You Distribute Reports and Dashboards.

• Report links are unavailable when the columns they are in are rolled up. See Dene Rollups.

• While you can create links to dashboards, you cannot link to a dashboard from a report that is being viewed in a
dashboard. Links to dashboards are unavailable when the reports they are in are viewed in a dashboard.

• You can create links to public or private reports and dashboards. Sta members with permission to view the
parent report can view any reports or dashboards linked to from the parent report, whether they are public or
private. Because of this, you should be familiar with the content of the report or dashboard you’re linking to so
sta members won’t be able to access sensitive information.

• You can’t create report links from columns that display values from hierarchical elds, such as the incidents
product hierarchy eld. In addition, columns can be associated with a report link or with a drill-down level in the
report, but not both.

• If a report or dashboard is deleted, any links to that report or dashboard are automatically disabled, but the
reports containing the links continue to function normally.
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Create an Unconditional Report Link  
Create an unconditional link to open a specic report or dashboard when you drill down on any value in a parent report’s
linked column.

1. Open the report you want to create the link from on the report designer.
2. If your report has multiple output levels, select the report level where you want to create the link.
3. Select the column where you want the link to display.

It does not need to be the column with the data used to lter shown on the linked report.
4. Click Report Linking on the Design tab and select Add Report Link.

The Report Linking wizard opens. The rst page of the wizard shows you the reports and dashboards you have
access to, excluding published reports. You can create links to any of the reports or dashboards shown on the
page, including those that are private.

5. Select the report or dashboard you want to link to and click Next.

After you select the report or dashboard you want to link to, you select the values you want to use for the
report’s or dashboard’s variables and runtime selectable lters, as shown here.

The values you specify are applied to the linked report or dashboard when it opens. Required variables and
lters are indicated with a red ag and you must set a value for these. You can also choose to dene values for
items that are not required.

The values you specify determine the information shown in the linked report when it opens. You generally want
to use a value that corresponds to the value clicked in the parent report to display data related to the value in
the parent report.

6. Select the type of value you want to use for the linked report’s or dashboard’s variables and lters from the Use
drop-down menu.

Type Description

Parent Column Value
 

Select this option to use the values in the parent report’s selected column to populate
the linked report’s variable or lter. When you click the link on a row in the parent report,
 the column’s value from the selected row is used as the linked report’s variable or lter
value.
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Type Description

 
This option is available only when the parent report includes a column with the same
data type, such as text, integer, or menu, as the linked report’s variable or lter.
 

Parent Filter Value
 

Select this option to populate the linked report’s variable or lter with the current value
from one of the parent report’s lters.
 
This option is available only when the parent report has lters with the same data type
and operator as the linked report’s variable or lter.
 

Parent Variable Value
 

Select this option to populate the linked report’s lter with the current value from one of
the parent report’s variables.
 
This option is available only when the parent report has variables with the same data
type and operator as the linked report’s variable or lter.
 

Default Value
 

Select this option to use the default variable or lter value specied in the linked report
for the variable or lter value.
 

Custom Value
 

Select this option to specify a custom value for the variable or lter. The values you can
enter depend on the data type and available options. For instance, if a lter uses a text
eld, you can enter the text you want to use for the lter’s value. If a lter uses a menu
eld containing sta accounts, you select the sta accounts you want from a menu.
 

7. From the Value drop-down menu, select the parent report’s column, variable, or lter you want to use to
populate the variable or lter in the linked report or dashboard. If you choose a custom value, enter the custom
value you want in the Value eld.

Note:  When you select values for the linked report’s variables and lters, the logical expression
displayed at the boom of the window is updated to reect the values you select. This is the
expression that is passed to the linked report or dashboard when you click the link. This information is
displayed for reference and cannot be edited.

8. Click Next.
The wizard presents options for specifying where you want the linked report to open.

9. Select the option you want to use to display the linked report or dashboard.

Option Description

Replace Report in the Same Window
 

Select this option to close the parent report and display the linked report instead.
 

Display Report in a Separate Tab
 

Select this option to open the linked report on a separate tab on the content pane.
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Option Description

Use Existing Tab
 

Select this option to open the linked report on an existing tab each time you click the
link. The tab is created the rst time you click the link. When you open the report again
from the same link, the report displays on the same tab.
 

Create a New Tab
 

Select this option to open the linked report on a new tab each time you click the link.
 

Display Report in a Split Window
 

Select this option to open the linked report in a split window. The parent report remains
open on one half of the window, and the linked report displays above or below the
parent report, or to the left or right of the parent report.
 

Top/Boom
 

Select these options to display the linked report above or below the parent report.
 

Left/Right
 

Select these options to display the linked report to the left or right of the parent report.
 

10. Click Finish.
11. Click Save on the Quick Access toolbar.

Related Topics
• Overview of Linked Reports

• How to Use Linked Reports

• Create a Conditional Report Link

Create a Conditional Report Link  
Use conditional links to open dierent reports or dashboards depending on the value you drill down on in the parent
report’s linked column.

1. Open the report that you want to create the link from on the report designer.
2. If your report has multiple output levels, select the report level where you want to create the link.
3. Select the column in the parent report where you want the link to display.

It does not need to be the column with the data used to create the link’s condition.
4. Click Report Linking on the Design tab ribbon and select Add Conditional Report Link.

On this page of the wizard, you specify the condition(s) that must be met for the link to be triggered. The link
you create is activated only when a value in the parent report meets the condition(s) you specify. You can add
other conditional links to the same column to open dierent reports or dashboards when selecting other rows
in the report.

The Conditional Report Linking wizard opens.
5. Click the Column drop-down menu and select the column in the parent report that you want to use to create

the link’s condition.
The column you select does not need to be the same column the link is displayed on. For example, you can
use the values in a hidden column to create the link’s condition, but display the link on another column in the
report.

6. Click the Operator drop-down menu and select the operator you want to use for the link.
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The operators displayed depend on the column’s data type.
7. Enter the value you want to use for the conditional link.
8. Click Next.

The remaining pages of the Conditional Report Linking wizard are identical to those on the Report Linking
wizard.

9. To add other conditional links, repeat steps 2 through 8.
10. Click Save on the Quick Access toolbar.

Related Topics
• How to Use Linked Reports

• Overview of Linked Reports

• Create an Unconditional Report Link

Reorder a Conditional Link  
If you create several conditional links on the same column, you can reorder them to ensure that links with conditions
that might overlap are triggered in the order you want.

You must create a conditional report link before you can reorder a conditional link. See Create a Conditional Report Link.

While ordering is irrelevant for conditional links with exclusive conditions, it can aect which linked report or dashboard
opens if you have multiple links that could match a particular column value.

1. Select the report column that is associated with the link and click Report Linking on the Design tab.
2. Select Manage Conditional Report Links.

The Manage Conditional Report Links window opens displaying all the conditional links that are associated
with the selected column. From this window you can add, remove, edit, and reorder conditional links.

3. Select the link you want to move and click the up or down arrow to move it to the position you want.
Conditional links are examined starting with the link at the top of the list. The rst link that matches the column
value is triggered and any other links that could match the column value are ignored.

4. Click OK.

Edit a Report Link  
After you create conditional or unconditional report links, you can edit them.

You must create a conditional report link or an unconditional report link to edit a report link. See Create a Conditional
Report Link and Create an Unconditional Report Link.

You can use the standard Linked Reports and Reports with Disabled Links reports to list reports that contain links to
reports and dashboards.

1. Open the report that includes the link on the report design center.
2. Select the report column that is associated with the link and click Report Linking on the Design tab.
3. To edit an unconditional report link, select Edit Report Link to open the Report Linking wizard.
4. To edit a conditional report link, select Manage Conditional Report Links. The Manage Conditional Report

Links window opens.
a. Click Edit next to the link you want to edit.

The Conditional Report Linking wizard opens where you can edit the link.
b. Click OK.

5. Click Save on the Quick Access toolbar.

Remove a Report Link  
After you create conditional or unconditional report links, you can remove them.
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You must create a conditional report link or an unconditional report link to edit a report link. See Create a Conditional
Report Link and Create an Unconditional Report Link.

You can use the standard Linked Reports and Reports with Disabled Links reports to list reports that contain links to
reports and dashboards.

1. Open the report that includes the link on the report design center.
2. Select the report column that is associated with the link and click Report Linking on the Design tab.
3. To remove an unconditional link from the column, select Remove Report Link.

The unconditional link is deleted.
4. To remove all conditional links from the column, select Clear All Conditional Report Links.

All conditional links are deleted.
5. To remove only some of the conditional links on the column, select Manage Conditional Report Links.

a. Click Delete next to the link you want to remove, and click Yes to conrm the deletion.
b. Click OK.

6. Click Save on the Quick Access toolbar.

Inline Aggregate Reporting  
Inline aggregate reporting lets you insert columns in custom reports to show aggregate information that could not
normally be displayed due to restraints on database query size.

The aggregate data you want displayed in a column is compiled in a separate report and then pulled into a column in
the primary report. This breaks the database query that would normally be required to return the data in a single report
into multiple queries from multiple reports.

Note:  You can pull data from several reports into columns in a single parent report. However, the parent
report cannot have more than 500 cells displaying inline aggregate data.

Using this feature helps avoid query limitations when running reports that include summaries of data from tables
containing large amounts of data, such as transactions or incident performance, particularly when joins do not exist
between all the tables you need to include in a report.

CAUTION:  Using inline aggregate reporting is not recommended for most reports where normal inner
or outer joins are used, since it will result in less ecient reports that may not run successfully. Use inline
aggregate reporting only when the query required to return aggregate data in a column results in a Cartesian
join between tables. This is when data is pulled from all rows in the tables required by the query, resulting
in a large number of rows being accessed. If you’re unfamiliar with Cartesian joins, or have questions about
whether using this feature will help a report run more eciently, please  submit a service request .

Related Topics
• Congure Inline Aggregate Reporting

Congure Inline Aggregate Reporting  
Inline aggregate reporting lets you insert columns in custom reports to show aggregate information that could not
normally be displayed due to restraints on database query size.

1. Create a column in a report to collect the aggregate data.
a. Click Analytics on the navigation pane.
b. Double-click Reports Explorer.
c. Do one of the following:
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- Click New Report and select a report format to create a new report.
- Right-click an existing report and select Edit.

d. Click Add Column on the Home tab.
The Column Denition window opens. See Add a Column to a Report.

e. Congure the column to display the aggregate data you want.
See Functions for Reports for a list of aggregate functions you can use in reports.

f. Add a runtime selectable lter or a variable to the report.
Inline aggregate reporting requires that the report you link to includes at least one variable or runtime
selectable lter. See Add Report Variables or Create a Fixed or Runtime Selectable Filter.

g. Click Save.
2. Create a new report or edit a report that will link to the column created in the previous step.

◦ Click New Report and select a report format to create a new report, or

◦ Right-click an existing report and select Edit.

3. Click Inline Aggregate on the Insert tab. The Inline Aggregate Wizard opens.
a. Enter a column header for the new column.
b. Enter an optional column description.
c. Click Next.
d. Select the report containing the aggregate column you want to link to and click Next.
e. Select the values you want to use for the linked aggregate report’s variables and runtime selectable lters.

The values you specify determine what data is shown in the aggregate column. Required variables and
lters are indicated with a red ag and you must set a value for these. You must also map at least one
indexed lter in the report containing the aggregate column to a column in the parent report

f. Select the values you want to use for the linked aggregate report’s variables and lters from the Use
drop-down menu.

Type Description

Parent Column Value
 

Select this option to use the values in a column in the parent report to
populate the linked aggregate report’s variable or lter.
 
This option is available only when the parent report includes a column with
the same data type, such as text, integer, or menu, as the linked aggregate
report’s variable or lter.
 

Parent Filter Value
 

Select this option to populate the aggregate report’s variable or lter with the
current value from one of the parent report’s lters.
 
This option is available only when the parent report has lters with the same
data type and operator as the linked aggregate report’s variable or lter.
 

Parent Variable Value
 

Select this option to populate the linked aggregate report’s lter with the
current value from one of the parent report’s variables.
 
This option is available only when the parent report has variables with the
same data type and operator as the linked aggregate report’s variable or
lter.
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Type Description

 

Default Value
 

Select this option to use the default variable or lter value specied in the
linked aggregate report for the variable or lter value.
 

Custom Value
 

Select this option to specify a custom value for the variable or lter. The
values you can enter depend on the data type and available options. For
instance, if a lter uses a text eld, you can enter the text you want to use for
the lter’s value. If a lter uses a menu eld containing sta accounts, you
select the sta accounts you want from a menu.
 

4. Click Finish.
5. Click Save.

How to Enable Editing Records on Reports  
When the rows in a report display information from unique records, such as incident reference numbers, contacts’
names, or organizations’ names, you can perform actions on the records directly from the report.

There are two methods to edit records directly from a report.

• Inline editing—Using inline editing, you can double-click or right-click an individual eld on a record shown
on a report to make changes to the eld. For instance, you can double-click the name of a sta member an
incident is assigned to and then select a dierent sta member from a menu that displays to assign it to
someone else. When you enable inline editing on a report, you can choose which elds can be edited inline.

• Record commands—By adding command links or buons to a report, you can edit, delete, copy, or perform
other actions on individual records shown on the report. Record commands are shown on reports as buons on
the ribbon, as links in the report rows, or as record commands when you right-click a record. When you enable
record commands on a report, you can choose the default action that should be performed when you double-
click a record on the report. You can also select which commands should be available as buons, links, and
right-click menu commands.

Note:  To edit records shown on reports, sta members’ proles must include permissions to modify the
appropriate record types.

Related Topics
• Overview of Sta Management

Overview of Using Record Commands on Reports  
The record commands displayed on a report let you perform actions such as opening, printing, and deleting records the
report displays.

Record commands can be displayed as links in a column, as buons on the report’s Home tab, or as options displayed
when right-clicking a row. Using record commands, you can perform actions on the record types that are displayed in
the report, but you can also perform actions on other record types that are related to the information displayed in the
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report. For example, if the report displays information about incidents, the report’s record commands can be congured
to perform actions on the contacts that are associated with the incidents.

Note:  Record command options aren’t applied when viewing reports in workspaces.

You can select from standard record commands, such as the edit or delete command. In addition, if your site has add-
ins that perform actions on records, you can add these as commands to a report as well.

Related Topics
• Overview of Add-Ins

Add Record Command Links to a Report  
You can select the record command links that you want to display in a report.

The links’ record commands must be enabled for the report on the Customize Record Commands window.

When you add record command links, they are displayed in a column that is automatically added to your report. You can
select the links you want to display. Not all the record commands you specify for the report are available as links.

When using the report, you can hide or display links that are enabled for the report from the Links buon on the Display
tab of the report.

1. Open the report you want to edit.
2. If your report has more than one output level, click the Level drop-down menu on the design surface and select

the level you want to add links to.
3. Click the Display tab.
4. Click Links and select the link you want to add to the report.

If the link you want to add to the report is not displayed on the Links buon, verify that the associated record
command for the link is enabled and that the record type you want the links to apply to is selected as the default
record. See Change Record Command Actions.
When you add the rst record command link to your report, the Action column is added to the report.

5. Click Save on the Quick Access toolbar.

Specify the Record Commands to Display on a Report  
By default, every record command available for your report is enabled, with the exception of the Incident > Fill Inbox
command, but you can remove record commands you do not want sta members to access.

The Records buon is disabled on reports that do not have rows that display or are associated with unique records.

Record command buons and right-click menu options are added automatically depending on which record commands
are enabled for the report. The enabled record commands also determine which record command links are available, but
these need to be added to the report manually. See Adding record command links.

1. Open the report you want to edit.
2. Click the Home tab and click Records.

The Customize Record Commands window opens.
3. To remove a record command from the current report level, expand the record commands list to nd the

command you want to disable and clear the check box next to the command.
4. To restore the default record commands for all levels in the report, click Reset All.
5. Click OK to save your changes.
6. Click Save on the Quick Access toolbar.
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Change Record Command Actions  
You can further customize the record commands in your report by selecting the record type that actions are performed
on when you click record command links or double-click the report’s rows.

The record type you select is also used as the default record type for record command buons and right-click menu
options, though you can select any of the record types when using buons or the right-click menu.

You can also choose the actions you want to perform when you double-click the report’s rows. For example, you can
choose to open a record, assign a record, or perform other actions when you double-click the row.

1. Open the report you want to edit.
2. Click Records on the Home tab.

The Customize Record Commands window opens.
3. To select the report level you want to congure, click the Level drop-down menu and select the report level you

want.
The options available on the Default Record and Default Action drop-down menus depend on the information
displayed in the report level you select.

4. Click the Default Record drop-down menu and select the record type you want the record command actions to
apply to.

The record type you select determines which links are available on the Links buon located on the Display
tab of the report designer, since dierent actions can be performed on dierent record types. See Add Record
Command Links to a Report.

5. To drill down into another report level instead of opening a record when a row in the report is double-clicked,
select None from the Default Record drop-down menu.
The additional report level must be congured with a drill-down link of Entire Row. See Create an Additional
Output Level.

6. Click the Default Action drop-down menu and select the action you want performed when you double-click a
row in the report.

7. To restore the default record command seings for all the levels in the report, click Reset All near the top of the
window.

8. Click OK.
9. Click Save on the Quick Access toolbar.

Enable Inline Editing  
When a report displays unique records, such as incidents or opportunities, the Inline Editing feature lets you edit the
values in columns shown on the report without opening the records.

You can congure inline editing in reports only if your prole includes the Modify Inline Report Editing permission on
the Analytics tab.

Individual values can be edited directly from the report, or groups of records can be selected to edit values in multiple
records. For example, if a report shows the sta member an incident is assigned to, you can change the assigned sta
member from the report without opening the record, or you can reassign several incidents shown on the report to a
selected sta member.

By default, inline editing is enabled for all editable columns in the report. Only certain columns, such as those
containing unique values, can be edited inline. Custom objects, other than menu-only objects, included in your report
can also be edited inline.

1. Open the report you want to edit.
2. Click Inline Editing on the Home tab and select Allow Inline Editing.

852



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

3. To specify the columns you want inline editing enabled for, click Inline Editing again and select Choose
Editable Columns.
The Editing Options window opens.

4. Enter eld information.

Field Description

Allow Inline Editing
 

Select this check box to enable editing from the report.
 

Automatically Save Inline Edit
Changes
 

Select this check box to enable the Auto Save feature by default.
 

Select Columns You Wish to Make
Available for Editing
 

Select the check boxes next to the report’s columns that you want to make available for
editing.
 
Reports with multiple output levels show all output levels in an expandable tree. Only
columns that return unique, editable values from database elds are available for
editing. For example, a column that returns the sta account an incident is assigned to
is available for inline editing, whereas a column that returns incident creation dates or a
count of incidents is not.
 

5. Click OK.
6. Click Save.

Related Topics
• How You Edit Data on a Report

• Overview of Sta Management

• Overview of Custom Objects

• Save Edits Performed Inline

Set Report Permissions  
Report permissions let you specify which proles can open or edit a report.

You can select Open and Edit permissions for each prole dened in your system. If sta members can’t perform certain
actions on a report, they may lack permission to edit the report.

Note:  Permissions applied to private reports are irrelevant until the report is made public.

1. Open the report you want to edit.
2. Click the Home tab.
3. Click Permissions.

The Permissions window opens.
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4. Select the check boxes next to the prole names to allow sta members assigned to the proles to open or edit
the report.

5. Click OK to save the permissions.
6. Click Save on the Quick Access toolbar.

Related Topics
• Create a Custom Report (video)

Change Report Properties  
Report options let you select the time zone that should be used for the report, change the report’s owner, and modify
seings that impact how the report functions when it is opened for viewing.

You can also congure automatic refresh of the data shown in the report, add notes to the report, and change the image
displayed for the report in lists.

1. Open the report you want to edit.
2. Click the Home tab.
3. Click Options and select More Options.

The Edit Seings window opens.
4. Enter eld information.

Field Description

Time Zone
 

Click this drop-down menu to select the time zone to use with the report. The dates and
times shown in the report’s lters, variables, and output columns are adjusted to reect
the time zone you select. The available options include the following:
 

◦ Same as Interface—The report’s time zone matches the time zone set for the
interface. This is the default seing.

◦ Same as Account—The report’s time zone matches that of the sta member who is
running the report. See Add or Edit a Sta Account.

A specic time zone you can select from a list of standard time zones.
 
The database query used to return data in the report always uses the time zone of the
interface. For example, if you select the GMT time zone for an incidents report and run
it on an interface with an EST time zone, the report could return incidents with a created
date of April 1st, 2011, but with reference numbers starting with 110331. This indicates
that the incidents were actually created on March 31st, 2011, in the EST time zone, but
the displayed date and time are adjusted to reect when the incidents were created
in the GMT time zone. In addition, if the report groups incidents by the day they were
created, the same number of incidents will display each day regardless of the time zone
that is used since they are grouped according to the interface’s time zone.
 

Owner
 

Click this drop-down menu to select a report owner. The report owner is the only sta
member who can view or edit the report, unless the owner grants permissions to other
proles. See Set Report Permissions.
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Field Description

Changing the owner of a private report makes the report unavailable to the previous
owner.
 

Open report without prompting for
search parameters
 

Select this check box to have the report automatically run and return data when it
is selected from a navigation list. The report uses the default values specied in the
report’s lters.
 
This option is referred to as Initial Run on the Reports explorer Find menu. See Search
for Analytics Items for information about nding reports.
 

Refresh report when data shown is
changed due to an action initiated
from this report
 

Select this check box to have the report’s output automatically updated when an edit to
a record is initiated from the report. The report refreshes only if a record is modied in
such a way that it no longer matches the report’s search criteria.
 

Open editor when report contains
only one row (quick search and
editor search reports only)
 

Select this check box to automatically open the record for editing when the report
returns only one record.
 
This option applies only to Quick Search reports and reports used in workspaces.
 

Cache the drilldown levels
 

Select this check box to enable caching of data shown in report output levels. When this
option is enabled, the data shown in the initial output level when you view a report is
stored on your workstation. When you view a second output level and then return to the
top level of the report, it loads quickly since the data you’re viewing is cached on your
workstation. The cache is cleared when you close the report.
 
When this option is not enabled, the database is queried every time you drill down to
an output level or return to a previous level even if you have recently viewed the output
level.
 

Return to previous level when
current level no longer has data
 

Select this check box to instruct the report to automatically display the previous output
level if the current output level no longer displays any records.
 

Allow server to change the data
source as necessary
 

Select this check box to allow Analytics to automatically change the data source if
necessary to allow the report to run. For example, if a report is congured to run on the
operational database but is unable to do so due to data constraints, selecting this check
box allows the report to run on the report database (also referred to as the replication
database). Clearing this check box forces reports to run on the data source that is
selected. See The KnowledgeSyndication Widget.
 
This check box is selected by default when you create a report, and is cleared
automatically any time the data source is changed on the Edit Seings window.
 

Set report to deferred execution
 

Select this check box to automatically queue the report when it runs. See How to Prevent
Automatic Queuing.
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Field Description

 
If this option is not selected but the report is automatically queued the next time it is
run due to meeting queuing criteria, the Set Report to Deferred Execution check box is
selected automatically. To prevent the report from being queued when it is next run, edit
the report and clear this check box.
 

Data Source
 

Select which database you want the report to run on. You can choose the operational
or the report database (also referred to as the replication database). See Overview of
Report Databases for more information about data sources.
 
This option is available only if your site has a report database. If your site does not have
a report database, contact your Oracle account manager for more information.
 

Report Database
 

Select this option if you want the report to run on your report database. This option is
helpful if your report queries a large amount of data since the query size restrictions on
report databases are more relaxed than those on operational databases.
 
If you select this option in a report that includes the Fill Inbox record command and a
sta member clicks Fill Inbox when using the report, the report will be automatically
congured to use the operational database. This ensures that current data is used when
incidents are assigned. See Overview of Incidents and Overview of Report Databases.
 

Operational Database
 

Select this option if you want the report to run on your operational database. This
option is helpful if you need the report to return the most current data available.
 
The operational database is selected by default when you create a new report.
 

Refresh all split levels
simultaneously
 

Select this check box to automatically refresh all report levels shown in split windows
when data in one of the report levels is refreshed. When this option is disabled, only the
data shown in the window selected when the refresh occurs is updated.
 

Automatically refresh report at a
regular interval
 

Options in this section let you congure automatic refresh of the report’s data to ensure
the most recent data is displayed.
 

Auto-refresh options visible at
runtime
 

Select this check box to add an arrow on the Home tab’s Refresh buon. Clicking the
arrow displays options to enable or disable automatic refresh and to change the refresh
interval time. When this check box is not selected, the report’s data is refreshed only
when the buon is clicked.
 

Auto-refresh enabled by default
 

Select this check box to enable automatic refresh of the data shown on the report.
 

Interval
 

Enter the number of seconds after which the data shown on the report is automatically
refreshed.
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Image
 

Click Change to select a dierent image to display next to the report in lists such as
navigation lists. The image that is displayed by default is determined by the layout
selected when creating a new report. When selecting an image, you can choose from
a list of standard images or from custom images that have been added in the Images
explorer. See Images Explorer.
 

Notes
 

Enter any text you want to add as a note to the report. The note displays on the Edit
Seings window, but does not display to anyone viewing the report.
 

5. Click OK.
6. Click Save on the Quick Access toolbar.

View a Report Audit Log  
You can open an audit log for a report to see when the report was created, edited, run, and published, and which sta
members performed these actions.

Since the audit log is a report, you can perform common report actions on the audit log, such as printing, forwarding, or
slicing.

The audit log shows you when the report was edited and generated, but not all actions performed, such as previewing
the report, are listed in the audit log. If you need to see every instance of a report or dashboard being generated,
printed, exported, and previewed, you can use the Expanded Report Audit Log. See View the Expanded Report Audit
Log.

1. Open the report on the report designer.
2. Click Audit Log on the Home tab.

The Audit Log window opens.
3. To access a list of actions that can be taken on the audit log, click Options.

See Overview of the Report Ribbon for descriptions of the actions.
4. Click OK.
5. Click X on the top right.

How to Review Report Performance  
Using certain standard reports and the report analyzer helps you identify reports that run slowly, or not at all, and
determine the cause.

Reports that are congured to examine large amounts of data may be problematic. These reports might use too few
lters, include a large number of tables, or might be running on an excessively large database.
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Running Large Reports
While you want to avoid running reports that examine large amounts of data, it may occasionally be necessary to do so
to meet your business needs. In such cases, you have several options.

• Run the report on the report database instead of the operational database so the report can query more data.
See Overview of Report Databases.

• Queue the report to run at a later time. See Overview of Queuing Reports.

• If the report includes multiple output levels, you may be able to use report linking to reduce the number of
tables and rows queried by the report. See Overview of Linked Reports.

Identifying Report Run Failures
You can view reports that fail to run and the types of failures they encounter using two standard reports available in the
Reports explorer in Public Reports/Common/Site Administration/Reports.

• Report Failure Details—This report lists reports that failed to run, and how often they failed, during a specied
date range. The reasons the reports failed to run are also listed. Reasons include Too Much Data, Timed Out,
and Unexpected Error. You can drill down on the rows in this report to view more specic information about
each failure.

• Summary of Report Failures—This report lists the types of report failures along with the number of times the
failure was encountered during a specied date range. You can drill down on the rows in the report to access
information in the Report Failure Details report.

Tip:  To create custom reports that display or lter on the success of report generation, you can use the Result
Code (result_code) eld in the Analytics Audit Log (ac_audit_log) table.

Related Topics
• Troubleshoot Reports Using the Report Analyzer

Troubleshoot Reports Using the Report Analyzer  
If you encounter problems running a report, or want to view potential issues after you create a report, you can run the
report analyzer to check the report’s database queries.

This helps you ne-tune custom reports to ensure they run as quickly and eciently as possible. The report analyzer
examines your report and provides suggestions as to how you can improve the report by removing database tables,
adding lters, and making other changes. The analyzer also shows you the estimated number of rows the report’s query
may need to access so you know if the report can run without encountering row limits.

Note:  Reports are analyzed using either the report or operational database, depending on which database
they are congured to use. See Overview of Report Databases.

1. Open the report you want to analyze on the report design center.
2. Click Analyze on the Home tab.

The report’s Search window opens where you can enter the lter and variable values you want the report to use
when it is analyzed.
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If your report lacks required runtime selectable lters or the Open Report Without Prompting for Search
Parameters check box is selected on the report’s Edit Seings window, the Report Analyzer window opens
instead of the Search window. See How You Search in Reports.

3. If you're presented with the report’s Search window, enter the search criteria you want to use and click OK.
The search criteria you specify can change the estimated number of database rows the query must examine.
The Report Analyzer window is similar to the Report Denition window and includes the same functions at
the top of the window (see View a Report Denition for information about the Report Denition window). The
report analyzer lists the report’s lters, tables, output levels, and the estimated number of rows the report’s
query will examine when it runs. If the analyzer nds potential issues with the report’s query, it lists the issues in
the Notes column next to the applicable report component.

Report Component Potential Issue

Filters
 

This section lists the expressions used for each report and level lter and identies
whether the lters’ elds are indexed in the database and whether the index is used.
Custom elds can be indexed for faster queries, though too many indexes can slow
down queries. The following messages can be returned in this section.
 
The lter contains a custom eld that does not have an index. To improve the
performance of this query, consider adding an index on the custom eld.
 
The lter contains a reference to a pseudo eld, so no index information is available.
 

Tables
 

This section lists the tables that are used in the report, along with the types of joins used
to link the data in the tables. Four messages can be returned in this section.
 
This table is in an outer join but there are one or more lters on elds in this table. Make
sure this is by design. If not, consider changing the join type to inner or changing these
lters to join lters to prevent an implicit inner join.
 
This table is not used in the report. Consider removing the table from the data set. If you
need to lter out rows in the parent table that do not have rows in this table, consider
adding a not null lter on the join eld in the parent table.
 
This table is not used in all report levels. To improve performance, consider using report
linking instead of drill-downs. With report linking, you can specify the table set for each
level.
 
The data set contains the Incident Performance (inc_performance) and the Transactions
(transactions) tables, but there are no lters that provide additional joins between the
two tables. To increase performance, consider adding a lter that provides an additional
join between the two tables.
 

Levels
 

This section lists the output levels (also called drill-down levels) that are used in the
report. One message can be returned in this section.
 
This level contains one or more columns with a sum_distinct expression. Sum_
distinct expressions have a negative impact on performance. If possible, consider a
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dierent approach that does not involve using a sum_distinct expression. You may
be able to remove the sum_distinct expression by converting any drill-down levels to
linked reports.
 

Rows
 

This section lists the estimated number of rows that will be examined by the query.
Messages display if the number of rows exceeds the threshold values for the operational
and report databases (also referred to as replication databases). Three messages can
be returned in this section. The messages vary depending on whether your site has a
report database in addition to the operational database and the Data Source options
specied on the report’s Edit Seings window.
 
The estimated number of analyzed rows for this query is X. This value exceeds the
threshold of 2,000,000 for the operational database. Consider using the report
database for this report. Otherwise, it is likely this will occur automatically.
 
The estimated number of analyzed rows for this query is X. This value exceeds the
threshold of 2,000,000 for the operational database. Since you have specied the
operational database for this report, it is unlikely the report will execute. Consider using
the report database for this report.
 
The estimated number of analyzed rows for this query is X. This value exceeds the
threshold of 5,000,000 for the report database. Consider adding or rening lters to
reduce the number of analyzed rows to below this threshold. Otherwise, it is unlikely the
report will execute.
 
The report will likely return a large number of rows. Consider using lters instead of
paging to navigate the result set.
 
A row estimate is not available because the report contains sum_distinct expressions.
 
Due to the complex nature of the report, a row estimate is not available.
 
The estimated number of rows is X. However, the underlying query contains a one-to-
many relationship so the estimate may not be accurate.
 

4. Click X on the top right to close the Report Analyzer window.
5. Click X on the top right to close the report.

Related Topics
• How to Review Report Performance
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Using Reports  

Overview of Managing Reports on the Reports Explorer  
The Reports explorer lets you manage standard and custom reports. From here, you can organize, locate, and view
reports.

When viewing a report, you can print, forward, and export the report. If the report allows inline editing, you can also edit
data shown on the report directly from the report.

You can adjust the report’s display options to beer suit your needs, and alter data characteristics to sort, lter, and
output the data in dierent formats.

How You View Reports  
Oracle Service Cloud includes numerous standard reports you can use to track activity in any application, such as Oracle
RightNow Feedback Cloud Service (Feedback).

You can view a detailed description of any report by viewing the report’s denition. If one of the standard reports does
not meet your needs, you can create a custom report to return the specic information you want. Custom and standard
reports are opened in the same manner.

You can also use the options on the report’s ribbon to search for information, change the report’s display, share the
report with others, and perform other actions. Some reports also include multiple output levels or link to other reports
or dashboards that you open to view additional information.

Open a Report from the Reports Explorer  
You can open reports using the Reports explorer.

Sta members with the appropriate permissions can open standard and custom reports from the navigation pane or
from the Reports explorer. You can double-click a report in a navigation list or double-click the Reports explorer to select
a specic report to open.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.

The explorer opens on the content pane with the folders tree on the left and a detailed list of the selected
folder’s contents on the right.

3. In the list on the right, right-click the report you want to open and select Open.

When you open a report, the Search window may be displayed where you can specify the search parameters
you want to use for the report. The window displays if the report has required runtime selectable lters or is
congured to display the Search window. For information about using the Search window, see How You Search
in Reports.

In addition, when you aempt to open reports that examine a large amount of data or that may take a long time
to run, you may be presented with an option to queue the report. See Overview of Queuing Reports.
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This table describes the standard sections you will see when you view reports. Reports may not include all
sections.

Field Description

Docked Filters
 

Docked runtime lters dened in the report display above the report output, allowing
you to quickly select dierent lter values. For information about adding docked
runtime lters, see Add Variables or Runtime Filters to Docked Filters.
 
You can dock output variables in reports in the same manner as runtime lters.
 

Report Header
 

Text added to this area displays near the top of each page in the report. See Add a Text
Field to a Header or Footer.
 

Output Descriptions
 

Report output descriptions let the report’s creator relay information, such as the report’s
intended purpose, to those who view the report. Output descriptions can be displayed
inline, on a separate tab, or on column rollover.
 

Search Criteria Descriptions
 

Descriptions of the lters in the report can be displayed to describe the report’s lters
and values. See Overview of Search Criteria Descriptions.
 

Charts
 

Any charts dened in the report display above the tabular report output. See How to Add
and Edit Charts.
 
When viewing a chart in a report, you can right-click the chart to switch to a two- or
three-dimensional view. When viewing a three-dimensional chart, you can right-click
the chart, select Rotate, and drag the chart to change the viewing angle.
 

Data Area
 

This area contains the tabular report output.
 

Report Footer
 

Text added to this area displays near the boom of each page in the report. See Add a
Text Field to a Header or Footer.
 

Data Exceptions
 

Records matching data exceptions dened in the report are agged, and a summary of
the data exception can be displayed in the report output. See Create a Data Exception.
 

4. If output or search criteria descriptions are displayed as a tab in the report, click the Descriptions tab to view
the descriptions. Descriptions can also be displayed as inline text in the report header, or by rolling over the
column names in the report.

Related Topics
• Run a Standard Report (video)
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View Data Using the Report or Layout View  
When you open a report, you can choose to view it using a layout or report mode.

The report view is used by default and lets you look at the report’s data, print the report, and work with the report’s
records if you have permissions to do so. However, you cannot add column calculations or change column formaing
using this view.

Most sta members use the report view when they look at a report. You can also look at the report using the layout
view, which lets you apply formaing options and calculations to individual columns in the report. For example, if you
wanted to add conditional formaing to a column to highlight data that met certain criteria in the column, you could
change to the layout view, select the column, and congure conditional formaing for the column. Or, to display a
calculation at the boom of a particular column, such as the total of the values shown in a currency column, you could
select the column and then select the calculation you want from the report’s Design tab. When using the layout view,
you can also change the width of individual columns, and move columns in a report if you want them displayed in a
dierent order.

1. Open a report.
By default, the report opens in the report view.

2. Click the Display tab.
3. Click the arrow on the Views buon and select Layout View to change the view.
4. To return to the report view, click the arrow on the Views buon and select Report View.

View a Report Denition  
If you want to see descriptions of a report’s output columns, search criteria, and other components, you can view the
report denition.

This can be helpful if you want to see exactly how the report was created or determine if the report meets your needs.
You can print a report’s denition, and you can export the output to a le for later viewing.

1. From the Reports explorer, do one of the following:

◦ Select a report and click View Denition.

◦ Open a report, click the Home tab, click Denition, and select View.

The Report Denition window opens.
2. To save the output from the report denition to a le for later viewing, click Export and select the le type.

You can select HTML, PDF, Excel, Image, and Delimited le types. See Export Report and Dashboard Data for a
description of these le types. You can also choose to export the denition to an XML le which you can use to
create duplicate reports on other interfaces. See Export a Report Denition to an XML File.

3. To print the page, perform these steps.
a. To preview the page layout page before printing it, click Print Preview. See Preview a Report.
b. To congure the page layout, click Page Setup. See Report Designer Page Setup Tab.
c. Click Print.

Your computer’s Print window opens where you can select the destination printer.
4. Click X on the top right to close the Report Denition window.

Export a Report Denition to an XML File  
You can save a report denition as an XML le for later viewing.

If you have multiple interfaces, you can import the XML le to copy a custom report from one interface to another. This
lets you create duplicates of complex custom reports on other interfaces without manually re-creating the reports.
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The following procedure explains how to export report denitions to XML les, which you can later import. See Import a
Report from an XML File.

1. To export a report denition from the Report Denition window:
a. Click the window’s Export buon.
b. Select Report Denition.

The Save As window opens.
2. To export a report denition while you’re viewing or editing it:

a. Click the Home tab.
b. Click Denition.
c. Select Export.

The Save As window opens.
3. Select a location for the le and enter a le name.
4. Click Save.

The report denition is saved as an XML le.

Related Topics
• View a Report Denition

Overview of the Report Ribbon  
When viewing a report, you can move between the Home, Display, and Page Setup tabs on the ribbon to access buons
that modify the report’s display, search for data, and edit records.

The buons on the report ribbon vary depending on the report view you use. When looking at a report using the layout
view, you can also access Design and Format tabs to adjust formaing and display options. The buons you see on
some of the tabs vary depending on the report’s conguration and on what is selected on the report.

Tip:  You can minimize the ribbon when viewing a report by double-clicking the active tab. Click the tab to
temporarily display the buons on the tab, or double-click the tab again to maximize the ribbon.

Each tab on the ribbon has one or more groups containing buons you can use to modify the report or items on the
report. Some groups have a buon to the right of their name that you can click to open windows. For example, you can
click the Background group’s buon on the Page Setup tab to open the Display Options window.

Windows give you access to the same features you can access from the ribbon, though the windows group the options
dierently, and sometimes contain options not available from the ribbon. When explaining features that can be
accessed from a window or the ribbon, we describe the feature using the window. However, the ribbon’s buons provide
shortcuts to most of the same features available on windows.

Report Home Tab  
The buons on the Home tab let you search for records in the report, refresh the report, and modify records displayed
in the report.

Buons to modify records are shown on the tab only when the current report level displays individual records. These
options vary depending on the type of records shown in the report and are disabled if the sta member viewing the
report lacks permissions to perform the action.
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Group/Buon Description

Record
 

The buons in this group let you work with the specic records returned in the report. The available
buons vary depending on the type of records returned in the report and permissions in your prole.
 
When editing custom reports, you can choose the buons you want to display on this group. See
Change Record Command Actions.
 
The buons in this group are displayed only if the report level you view returns unique records that can
be edited such as incidents, answers, contacts, or organizations.
 

Open
 

Click this buon to open the selected record. To open a record that is associated with the selected
record, click the arrow on the buon and select the type of record you want to open. For example, you
could open the contact record for the customer who submied the selected incident.
 

New
 

Click this buon to create a record of the same type as the record selected on the report. To create a
record of a dierent type, click the arrow on the buon and select the type of record you want to create.
 

Print
 

Click this buon and select the record you want to print. You can print the selected record or another
record associated with the selected record. For example, to print the contact record of the customer
who submied the selected record, click the Print buon and choose Contact.
 

Copy
 

Click this buon and select the record you want to copy. You can copy the selected record or another
record associated with the selected record.
 

Assign
 

Click this buon and select the record you want to assign to another sta member. You can assign the
selected record or another record associated with the selected record.
 

Delete
 

Click this buon and select the record you want to delete. You can delete the selected record or another
record associated with the selected record.
 

Preview Answer
 

Click this buon to view the selected answer as it will display on your site’s customer portal. This buon
is displayed only when viewing a report that lists answers.
 

Forward
 

Click this buon to forward the selected record in an email.
 

Propose
 

Click this buon to propose the selected incident as an answer. This buon is displayed only when
viewing a report that lists incidents.
 

Fill Inbox
 

Click this buon to assign incidents to yourself from incident queues. This buon is displayed only
when viewing a report that lists incident information and when the permissions in your prole let you
pull incidents from queues. This buon must be manually enabled on custom reports. See Change
Record Command Actions.
 
If the report is congured to use the report database, it will automatically be updated to instead use
the operational database when you click Fill Inbox. This ensures that the report uses current data when
assigning incidents. See Fill Your Inbox and Overview of Report Databases.
 

Email
 

Click this buon to open your default email program to send an email to the contact associated with
the record.
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Group/Buon Description

Monitor
 

Click this buon to open the chat sessions workspace to monitor agents’ chat sessions. This buon
is displayed only when Chat is enabled and when the permissions in your prole let you monitor chat
sessions.
 

Force Logout
 

Click this buon to log out the selected sta account. This buon displays only when the report returns
sta account information and can be enabled or disabled on custom reports. See Change Record
Command Actions.
 

Editing
 

This group is displayed when inline editing is enabled on the report. The buons in this group let you
save and edit records using inline editing. See How You Edit Data on a Report.
 

Data Set
 

The buons in this group let you search for data in the report, refresh the display, and reset the search
criteria to the report’s defaults. See How You Search in Reports.
 
The buons in this group aren’t available when viewing a report that was queued. See Overview of
Queuing Reports.
 

Search
 

Click this buon to open the report’s Search window to select criteria for variables and runtime
selectable lters.
 

Refresh
 

Click this buon to reload the data shown using the report’s current search criteria. If sta members
are permied to change automatic refresh seings, an arrow is added to the buon. You can click the
arrow to enable or disable automatic refresh and set the refresh interval. See Change Report Properties
for information about changing refresh intervals.
 

Reset
 

Click this buon to reload the data shown using the report’s default search criteria.
 

Find
 

Click this buon to open the Find window to enter text, numeric values, or special characters you want
to locate in the report’s output. Report cells that contain the search value are highlighted on the report.
See Find Content in a Report.
 

Find Next
 

Click this buon to highlight the next instance of the search values entered on the Find window.
 

Clear
 

Click this buon to clear the search values entered on the Find window.
 

Analyze
 

The buons in this group let you sort the data shown on the report and apply auto ltering, rollups,
 and slicing to the data.
 

Auto Filter
 

Click this buon to enable auto-ltering in the report. Auto-ltering provides column ltering after the
report has been generated. See Enable Auto Filters.
 

Sort
 

Click this buon to open the Sort window and select which output columns to sort by and the sort
method. See How You Change Report Sort Order.
 

Rollups
 

Click this buon to select rollup options and open the Rollups window. See Dene Rollups.
 

Slice
 

Click this buon to select slice options and open the Slice window. Slicing groups data so you can view
only the subset of records you’re interested in. See How You Slice Report Data.
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Group/Buon Description

 

Report
 

The buons in this group let you export the report, forward the report in an email, save and restore
default seings, and view and export the report denition.
 

Export
 

Click this buon to export the data from a report to a le for use with third-party applications. You can
export report data in the following formats: HTML, PDF, Excel, XML, Image, and Delimited. See Export
Report and Dashboard Data.
 
Permission to export, print, and forward reports must be enabled in your prole for this buon to
display. See Overview of Sta Management.
 

Forward
 

Click this buon to send the report to individuals or distribution lists in an email. See Forward a Report.
 
Permission to export, print, and forward reports must be enabled in your prole for this buon to
display. See Overview of Sta Management.
 

Default Seings
 

Click this buon and select Save as Default to save your personalized display and data seings for a
report for later use. Select Restore to remove personalized display and data seings from a report and
restore the seings to those dened in the report. See Reset Display and Data Seings.
 
This buon is not available on a report’s Home tab when viewing the report in a dashboard.
 

Denition
 

Click this buon and select View to view the report denition, showing descriptions of the report’s
tables, columns, lters, and other information describing the report’s structure. Click Export to export
the denition to a le which you can import into another interface to copy the report. Click Edit to open
the report for editing on the report designer.
 
See View a Report Denition. For information about editing reports, see Open the Report Designer.
 
This buon is not available when viewing a report that was queued. See Overview of Queuing Reports.
 

Report Display Tab  
The display tools let you adjust the fonts, colors, margins, and other display seings in the viewed report.

Field Description

Views Click the arrow on this buon to choose whether to view the report using the report view or layout
view. See View Data Using the Report or Layout View.

Auto Format Click this buon to apply a style to a report. See Apply a Style to a Report.

Sections The check boxes in this section let you show or hide the Docked Filters, Charts, Exceptions, Report
Header, and Report Footer report sections. You can also use the buons in the group to select how you
want to display the data, search criteria descriptions, and output descriptions.

Data Click this buon to select how you want to display the report’s data. You can choose to hide the data,
 display the data in a tabular layout, or display it in a record layout. See Display Data Using Record or
Tabular Layouts.

Search Criteria Click this buon to hide or show the report’s search criteria. You can show the criteria inline or on a
separate tab. See Add Search Criteria Descriptions for information about search criteria descriptions.
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Field Description

Output Descriptions Click this buon to hide or show the report’s output description. You can show the description on
column rollover, inline, or on a separate tab. See Display Output Descriptions for information about
output descriptions.
 

Options The buons and check boxes in this group let you add page breaks to the report, apply cross tabs, add
links and row numbers, x column headers, show multiline calculations, and select the elds and data
exceptions you want to view.

Field Chooser Click this buon to open the Field Chooser window and show or hide output columns in a report. See
Hide or Show Columns Using the Field Chooser.
 

Cross Tab Click this buon to select cross tab options and open the Cross Tab window and select the output
columns to use as cross tabs. See Dene a Cross Tab Report.
Open the Cross Tab window and select the output columns to use as cross tabs.
 

Page Report Click this buon to add page breaks to a report and select the number of records to display on each
page. See Add Page Breaks.

Links Click this buon to select the action links you want displayed on the report or to hide links that you do
not want displayed. The available links vary depending on the type of record the report returns and on
the links that are enabled when editing the report.
This buon is active only if the current report level displays unique records and the report is congured
to display links by default. See Add Record Command Links to a Report.
 

Exceptions Click this buon to show or hide data exceptions. See Show or Hide Data Exceptions.
This buon is active only if the current report level includes data exceptions.
 

Guide Click this buon to congure the report to display guided assistance response data in a tree format.
See Display Guided Assistance Information in Tree Format.
This buon is active only if the report includes data from the Guided Assistance Responses (decision_
tree_responses) table. The buon is also disabled if the current report level is congured to display
data using cross tabs.
 

Fix Column Headers Select this check box to x the column headers. Fixed column headers do not move when you use the
vertical scroll bar.

Row Numbers Select this check box to display row numbers in the report.

Multiline Calculations Select this check box to display calculations on separate rows.

Report Page Setup Tab  
The Page Setup tab lets you congure printing options. You can also change the background, margins, and width of
reports.

Each tab has one or more groups containing buons you can use to modify printing or display options. Some groups
have an arrow to the right of the group name that you can click to open a window. For example, you can click the arrow
on the Background group to open the Display Options window.

Windows give you access to the same features you can access from the ribbon, although the windows group the options
dierently, and sometimes contain options not available from the ribbon.
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Group/Buon Description

Print The buons in this group let you congure printing options and add the Page Header and Page Footer
sections. Click the arrow on the Print group to open the Page Setup window. See Print a Report.
This buon group displays only if your prole includes the Print/Export/Forward Reports permission.
See Analytics Permissions.
 

Print Margin Click this buon to select the size of the margins used when printing. The available options are Normal,
 Narrow, Medium, and Wide.

Size Click this buon to select the paper size. The available options are Leer, Legal, Executive, A3, A4, and
A5.

Portrait/Landscape Click these buons to print in portrait or landscape mode.

Page Header/Page Footer Select these check boxes to include a page header and page footer when printing the report.

Print to Fit Select this check box to scale your output to your printer default page width and send it to the printer.

Background The buons in this group let you add a background color. You can add a gradient color to blend into
the primary color and choose how intense the colors should be with the Transparency seing. Click the
arrow on the Background group to open the Display window.

Fill Color Click this drop-down menu to select a background color.

Gradient Click this drop-down menu to apply a gradient to the background.
This option is available only after you have selected a ll color.
 

Transparency Click this drop-down menu to apply a transparency to the background.
This option is available only after you have selected a ll color.
 

Display The buons in this group let you add margins and set the width. Click the arrow on the Display group
to open the Display window.

Margin Click this buon to dene the amount of white space around the printed output. The available options
are None, Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels
for the top, boom, left, and right margins.

Width Click this buon to select the width of the entire printed output. The available options are Best Fit and
t to Window.

Report Design Tab  
When viewing a report in the layout view, you can select a column and select options on the Design tab to change how
the data in the column is presented. For example, you can add calculations to the column or roll up the column’s data.

Note:  This tab displays only when editing reports or viewing them using the layout view. See View Data Using
the Report or Layout View.

Group/Buon Description

Arrange
 

The buons in this group let you move and hide the selected column.
 
To show hidden columns, right-click the header of a visible column, select Insert Hidden Column, and
select the column you want to show.
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Group/Buon Description

Sort
 

Click this buon and select Sort Ascending or Sort Descending to sort the data in the report by the
values in the selected column. See How You Change Report Sort Order.
 

Calculations
 

The buons in this group let you add calculations to the selected column. You can hover over each
buon to view a description of the calculation. You can also choose to show multiple calculations on a
single row or on separate rows. See Add Calculations to a Report Column.
 

Rollup
 

The buons in this group let you group the information in the report by the selected column. You can
also change the ordering if your report has multiple rolled-up columns. See Dene Rollups.
 

Slice
 

The buons in this group let you slice the data in the report by the selected column. You can also
change the slice level if your report’s data is sliced by more than one column. You can choose to display
slice columns as a tree or as links. See How You Slice Report Data.
 

Report Format Tab  
Buons on the Format tab let you change the formaing of your report.

When viewing a report in the layout view, you can select a column and select options on the Format tab to change how
the data in the column is displayed. For example, you can change the fonts, hide repeating lines of data, and replace
numeric data with gauges.

Note:  This tab displays only when editing reports or viewing them using the layout view. See View Data Using
the Report or Layout View.

Group/Buon Description

Font
 

The buons in this group let you change the font style, size, and color. You can also select font
aributes, such as bold and italic, and change the text’s alignment. In addition, you can add a
background color.
 

Margin
 

Click this buon to select the width of the margins around the selected column. The available options
are None, Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels
for the top, boom, left, and right margins.
 

Border
 

The buons in this group let you add borders to the column and change the borders’ display options.
You can identify which borders you want and choose the borders’ color, size, and style.
 

Display
 

The buons in this group let you apply conditional formaing to the column, change the column’s
width, freeze the column, and hide repeating values in the column. You can also select other display
options for the column.
 

Conditional Formaing
 

Click this buon to apply conditional formaing to the column’s data.
 

Width
 

Click this buon to select a width for the column. Select Best Fit to automatically set the width based
on the amount of space needed to display the column’s contents. Best Fit also takes into account the
width needed by other columns in the report. Select Percentage to specify a percentage of the total
report width for the column.
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When using Best Fit, all content in the report is examined to calculate column width before the report
displays. To reduce the report load time, enable Improve Display Performance. See Change Data
Display Options.
 

Freeze Column
 

Click this buon to x the selected column in place so it does not move when you horizontally scroll the
report. This can be helpful if you want to continue to view the rst column in the report while scrolling
the report to see the columns on the right of the report.
 
When you x a column, all columns to the left of the column are also xed. You can still scroll the
columns to the right of the xed column.
 

Hide Repeating
 

Click this buon to hide consecutive repeating values in the column. For example, if the name of a sta
member is shown in the column in ve consecutive rows, you can hide repeating values to show the
name in only the rst column.
 
If the Exclude Hidden Values from Calculations check box is selected on the Column Format window’s
Alignment tab, any calculations on a column with the Hide Repeating option enabled do not include
values in hidden rows.
 

Options
 

Click this buon to select display options for the column.
 

Number
 

The options in this group let you display numeric values as a gauge and select numeric formats. This
group displays when selecting a column containing numeric values.
 

Date
 

The options in this group let you select a date format for the column and view the format. This group
displays when selecting a column containing date/time data.
 

Related Topics
• How You Edit Column Formaing

Drilling Down in Reports  
The drill-down feature lets you click data in a report to open another report, dashboard, or output level to view
information related to that shown in the rst report or output level.

For instance, the rst level of the standard Incidents by Category report displays category names and the number of
incidents in each category grouped by date range. By clicking a category name in the report’s chart or tabular data,
you can drill down on the category to open a new output level in the report showing the number of incidents in each
subcategory. You can then drill down on each subcategory to open an additional level showing details about the
incidents in the subcategory.

By default, output levels opened from drill-down links replace the parent output level on the content pane. You navigate
back to other output levels, including the report’s top level, by clicking the level you want at the top of the report. Drill-
down levels, reports, and dashboards opened from drill-down links can also be congured to display separately from
the parent report. See Overview of Report Output Levels.
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Tip:  Usually, when drilling down into another output level in a report, the database is queried to ensure the
most current data is displayed even if you have already viewed the output level. However, this can take extra
time and may be unnecessary when viewing reports with data that does not change frequently. To more
quickly load report output levels you have already viewed, you can cache the data shown in each level. See
Change Report Properties.

Most reports with drill-downs open another output level in the same report. However, you can also link reports together
to open another report when you click a drill-down link. See Overview of Linked Reports.

View Your Database Data Dictionary  
You can use the data dictionary to view information about the tables and elds in your site’s Oracle Service Cloud
database.

The information returned in reports and dashboards is stored in your site’s database, allowing you to see vital
information about your customers, sta members, and interfaces. Using the data dictionary, you can view details about
all the tables and elds in the database, such as eld names, descriptions, and database types. You can add the Data
Dictionary component to any navigation list. See Change Your Navigation Pane Seings.

Note:  Not all the information in the database is accessible to Oracle RightNow Analytics Cloud Service
(Analytics).

1. Click Conguration on the navigation pane.
2. Expand Database, and then double-click Data Dictionary.

The content pane displays a list of all the tables in the database.
3. Click a table to view the table information.

The details that display depend on the table you have selected.

Field Description

Table Label Lists the descriptive table name used in the data dictionary throughout Oracle Service
Cloud.

Table Description Displays a description of the table.

Tbl Displays the table ID number.

Visibility Indicates the products and components that use the table, such as Service, Oer
Advisor, and Chat.

Custom Fields Indicates whether custom elds are allowed in the table.

Primary Key Lists the primary key columns. Click a column to view the column information.

Columns Lists the columns contained in the table. Click a column to view the column information.

Indexes Lists the indexed columns in the table. Click an indexed column to view the column
information.

4. To view column details, click a column in the Table Information section. The details that display depend on the
column you select.
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Field Description

Column Label Displays the descriptive column label used by the data dictionary throughout Oracle
Service Cloud.

Column Suxes Indicates the suxes that can be used with this column in analytics, such as .id or
.name.

Column Description Displays a description of the column.

Column Type Displays the type of column, such as menu eld or major join eld.

Data Type Lists the column data type, such as integer or varchar.

Length Lists the number of characters allowed in the eld.

Column Aributes Lists the column aributes, such as not nullable or unique.

Analytics Usage Indicates how the column can be used in analytics.
 

◦ All—Can be used anywhere in the report.

◦ Display—Can be used in a display column.

◦ Exception—Can be used in an exception.

◦ Filter—Can be used in a regular (node) lter.

◦ Group—Can be used to group.

◦ Group Filter—Can be used in a group lter.

◦ Join Filter—Can be used in a join lter.

◦ No Search—Can be used in a display column, exception, or group lter, and can be
used to group or sort.

◦ Search—Can be used in a regular, group, or join lter, and exception.

◦ Sort—Can be used to sort.

Joins Lists the columns that the selected column is joined to.

How You Search in Reports  
You can search for specic records in reports from the Search window.

You search for specic records in reports from the Search window. You can open the Search window from the report’s
Home tab. This window also opens automatically when the report includes required runtime lters or when the Open
Report Without Prompting for Search Parameters report option is not selected. See Change Report Properties.

The options available when searching for information consist of the runtime lters, output variables, sorting options,
and other search parameters added when the reports are created or edited. You can modify the layout of these options
on the window and save the layout for later use (see Overview of the Search Window). The search parameters are
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specic to each report, though many reports share similar lters and output variables. While most search parameters
need lile or no explanation, some are unique and require additional explanation.

After you perform a search, you may nd that the data does not include information from the current day. Certain
database tables contain cached data that is updated nightly. See How You Use Cached Data in Reports.

Note:  Reports are intended to output only the information you need to view or access for a specic purpose.
We recommend that you congure custom reports to include xed lters or required runtime selectable lters
to limit the data they can return. See Overview of Report Filters.

After generating the report using the search criteria you want, you can quickly locate specic content displayed in the
report using the Find feature. See Find Content in a Report.

Related Topics
• Run a Standard Report (video)

Search for Records in a Report  
Search parameters let you search for records in a report.

1. Open the report you want to search in.
2. Click the Home tab.
3. Click Search. The Search window opens.
4. To change the layout of the Search window, including the sizes and ordering of lters and variables, you need to

switch to Search Design Mode.
a. Click the Gear icon next to Seings, or click Seings and select Enter Search Design Mode.
b. Edit the layout as described in Overview of the Search Window.
c. Click Set as Default Layout to exit Search Design mode and save the layout to your computer.

When you view the Search window when you next open the same report from your computer, the
window uses the layout you saved.

d. To restore the default layout, click Seings and select Restore Default Layout.
5. To resize the Search window, drag the borders.

The window size is saved to your personal seings so it will open with the size you specify the next time you
open the window when running the same report.

6. Select the lters, sort options, and record limit for the report.

Note:  Search options often include date range lters and date grouping output variables. See Filter
Date Ranges and Date Grouping Output Variables.

Field Description

Filters
 

This section displays the report’s runtime selectable lters. The methods used to set the
lter values vary depending on the lters’ data types and operators. For example, the
values might be multi-selected from menu lists, specied in date elds, or entered in a
text eld. Text area elds are not available for use in report lters. See Create a Fixed or
Runtime Selectable Filter.
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Field Description

This section also lists output variables that have been added to the report. Output
variables can have the same types of selection methods as runtime selectable lters.
See Variables.
 
If the lter or variable displays a menu list, you can select all options in the list by
selecting the Select All check box, or you can clear all options in the list by clearing the
Select All check box. To quickly locate specic values in menu lists, enter the rst few
leers of the value you want in the lter’s Search Text eld. To view the menu options
you have selected from a long menu list, click the splier bar to the right of the list.
 

Limit and Order
 

Options in this section let you limit the number of rows returned in the report and select
how the report output should be sorted.
 

Limit To
 

Select this check box to limit the number of rows returned on each page of the report’s
output level or on the entire output level. Limiting the total number of records returned
on the output levels prevents reports from returning more records than can be easily
viewed or printed.
 
The VRL_HARD conguration seing sets a hard limit on the number of rows that
can be returned in a report. Values entered in the Limit To eld that exceed this are
ignored. See Analytics Conguration Seings for information about VRL_HARD and
other conguration seings that can impact reports.
 

Rows
 

Enter the number of rows that should be returned.
 

Per Page
 

Select this check box to change the number entered in the Rows text box from a hard
limit on the total number of rows returned in the report to a limit on the number of rows
returned on each page of the report.
 

Order By
 

Click the current sort order elds to open the Sort window where you can select dierent
sort options. The report’s default sort order is displayed with the primary sort eld listed
rst, followed by any subsequent sort elds. The direction each sort eld is ordered in
is also indicated (Asc for ascending order and Desc for descending order). See How You
Change Report Sort Order.
 

7. To save the lter values you select to the local seings on your workstation, click Seings and select Save as
Default Values. These saved values are used as the defaults when you run the report again when you’re logged
in with the same sta account.
The default values are overwrien if you select dierent values and click this buon again. If the report is later
edited to change lters, the default lter values stored in your local seings are ignored.

8. To restore the search values to the report’s default search values, click Seings and select Restore Default
Values. This deletes saved search values from personal seings.

This option is disabled if the report’s current search parameters were not populated from your personal
seings. See Change Your Personal Seings.
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9. To reset the search parameters’ values to the default values that were populated when the report was opened,
click Seings and select Reset Values.

10. To quit without saving your changes, click Cancel.
11. Click Search to search the report with the search parameters you selected.

Overview of Unique Search Parameters  
Unique search parameters are used in lters for returning specic data to the report.

While most of the lters and variables you see on the Search window are self-explanatory, these search parameters may
require more information to use correctly.

• Date Ranges

• Date Grouping Variables

• Incident Performance Intervals

• First Contact Resolution Rate

Related Topics
• Variables

• Create a Fixed or Runtime Selectable Filter

Filter Date Ranges  
You can use runtime lters to select a date range.

Most of Oracle Service Cloud’s standard reports include runtime lters created from date/time elds that let you
select a time and date range on which to lter the report’s data. (Date ranges between January 1, 1901 and January 17,
2038 are supported.) Which records are included in the time period depend on the type of report. For example, the
Incident Activity report includes the Date Created runtime lter, which you can use to display incidents created during a
particular date range.

You have several options when selecting a date range. For example, you can select whether you want to use exact dates,
a period of time relative to today’s date, or even the current time. When the Relative check box is cleared, you can type
in a specic date and time, or click the calendar next to the date and time to view a calendar and select a specic date.
By selecting the Relative check box, you can dene relative times to search on, such as the previous three months,
instead of absolute times.

Note:  The Time Zone report option can be used to change the time zone reected in the dates and times
shown in a report’s lters and output columns. By default, the time zone of the interface is used. See Change
Report Properties.

Dene a Relative Date Range in a Filter  
You can specify a relative date range in date or date/time lters. For example, a relative range could be from six months
ago to three months ago, or a week ago to the current time.

1. Select the Relative check box on the Search window to switch from a specic date to a relative date.
2. Click the Calendar icon to display the relative options.
3. Enter eld information.
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Field Description

Oset By
 

Enter the number of time units to use in this eld. Values can be positive or negative.
For example, use negative values to report on a date range of 6 months ago to 1 month
ago.
 

Time Units
 

Select the time unit to use from this drop-down menu. The available options are
Minutes, Hours, Days, Weeks, Months, Quarters, and Years.
 

Exactly
 

Select this option to use the exact time period entered. For example, if you run a report
at noon on a Wednesday that returns records created from exactly one week ago to
the current day, the report returns records created between noon on Wednesday of the
previous week and the current day.
 

Rounded to Beginning of Time
Period
 

Select this option to round the selected time period to the beginning of the time period.
For example, if you run a report on a Wednesday that returns records created from one
week ago rounded to the current day, the report returns records created between 12:01
A.M. on Sunday of the previous week and the current day.
 

4. Click OK.

Date Grouping Output Variables  
While most options on the Search window are runtime selectable lters, which limit the returned data, date grouping
options are output variables that group the report’s data by the time period in which a specied event occurred.

Date grouping output variables can be added to custom reports and are frequently used in standard reports. For
example, the Agent Activity standard report displays incidents that were assigned to sta members within a certain
time range. The default time range is Year/Month/Day, so a row is displayed for each day in the selected date range
listing the number of incidents assigned to the agent per day. However, you can select from the options on the Date
Grouping menu to group the data by a dierent time period, such as week or quarter.

Note:  When date groupings are shown in the report’s output, they display as the number associated with
the time period. Selecting Year/Week, for instance, displays the year followed by the number of the week
(2015/23). However, the display format of grouped date columns can be changed by editing the Group Date
Format conguration seings located on the Conguration Seings editor in the Group Date Format folder
(RightNow Common/General AnalyticsOptions/Group Date Format). See Overview of Site Conguration
and Analytics Conguration Seings for descriptions of the conguration seings that impact reports.

Incident Performance Intervals  
Incident performance intervals are used as runtime selectable lters in several standard Oracle RightNow Cloud Service
(Service) reports.

Incident performance intervals can be added as lters or output columns to custom reports, using the Incident
Performance (inc_performance) table. See Create a Fixed or Runtime Selectable Filter and Add a Column to a Report.
Incident performance intervals help you track the length of time between events that occur in the life of an incident.
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For example, the Create to Initial Response interval tracks the time between the incident’s creation and when the rst
incident response was sent. There are several types of intervals, some of which can overlap others.

Note:  The content in the Incident Performance (inc_performance) table is updated nightly by the
Agedatabase utility. See How You Use Cached Data in Reports.

Some intervals can occur more than one time in the life of an incident. For instance, the Assign to Response interval
records the time between an incident being assigned to an agent and the agent sending a response to the incident. If
the incident is assigned to and responded to by several agents, several instances of this interval are recorded for the
incident.

The following incident performance intervals are available for use in reports:

• Create to Initial Response—Measures the interval between the creation of the incident and the rst incident
response being sent from an agent.

• Status Change to Response—Measures the interval between an incident’s status type being changed from
Waiting or Solved and being set to Unresolved.

• Assign to Response—Measures the interval between an incident being assigned to an agent and the rst
response following the assignment.

• Create to Final Resolved—Measures the interval between the creation of the incident and the last time the
incident was set to the Solved status type.

• Last Assigned to Final Resolve—Measures the interval between the last time the incident was assigned and the
last time the incident was set to the Solved status type.

• Create to Initial Assigned—Measures the interval between the creation of the incident and the rst time the
incident was assigned to an agent.

• Create to Initial Resolved—Measures the interval between the creation of the incident and the rst time the
incident was set to the Solved status type.

• Assigned to Reassigned—Measures the interval between the incident being assigned to an agent and the
incident being assigned to a dierent agent or to no agent.

• Status Change to Reassigned—Measures the interval between the incident being changed from a Waiting or
Solved status type to Unresolved and the incident being reassigned to another agent.

• Queued to De-queued—Measures the interval between the time an incident enters a queue to the time the
incident is moved to no queue or a dierent queue. If the incident’s queue does not change, the interval ends
when the incident is set to the Solved status type.

• Queued to Initial Assigned—Measures the interval between an incident being placed in a queue and the
incident being assigned to an agent for the rst time.

• Queued to Initial Response—Measures the interval between an incident being placed in a queue and being
responded to for the rst time.

• Queued to Initial Resolved—Measures the interval between an incident being placed in a queue and being set
to the Solved status type for the rst time.

• Backlog—Measures the interval between an incident being created, or being changed from the Waiting or
Solved status type to the Unresolved status type, or being added to a queue, to the incident being edited (with
the edit saved).

• Incident Edit—Measures the interval between an incident being edited and the edit being saved.

• Servicing—Measures the interval between an incident being created, added to a queue, or changed from the
Waiting or Solved status type to the Unresolved status type, to the incident being set to the Waiting or Solved
status type or being added to a dierent queue.
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• Initial Response to Initial Resolved—Measures the interval between the incident rst being responded to and
rst being set to the Solved status type.

• Queue Initial Response to Initial Resolved—Measures the interval between the time an incident that is assigned
to a queue is responded to and the time the incident is set to the Solved status type, while in the same queue.

• Final Waiting to Final Resolved—Measures the interval between the last time an incident is set to the Waiting
status type and the last time the incident is set to the Solved status type.

First Contact Resolution Rate  
The First Contact Resolution Rate (FCRR) is used in several standard Service reports and can be included in custom
reports. This calculation can be used to search by or display the percentage of incidents that were resolved after only
one response.

To use the FCRR correctly, it is important to understand how the result is derived. The FCRR is calculated by taking the
number of incidents solved after one response by the agent and dividing this number by the number of incidents that
were solved after one or more responses. To ensure your agents’ performance is reected in the FCRR, some incidents
and responses aren’t included in the calculation. Incidents solved without a response being sent aren’t included, and
responses automatically appended by rules aren’t included. If an incident is responded to by a sta member and is then
reassigned, only the responses sent by the agent who solved the incident are included.

Find Content in a Report  
You can search for specic text, numeric values, or special characters in the content displayed in a report using the Find
feature.

When using the Find feature, cells on the report page currently being viewed that contain what you searched for are
highlighted. Content on other pages or drill-down levels in the report must be searched separately.

1. Open the report you want to nd content in.
2. Click the Home tab.
3. Click Find.

The Find window opens.
4. Enter the search value you want to nd in the report in the Find Text eld.
5. To highlight cells in the report only if the content matches the case you use in the search value, select Match

Case.
6. To highlight cells in the report only if the cell content exactly matches the search value you enter in the Find

Text eld, select Match Entire Cell Contents.
7. Do one of the following:

◦ Click Find Next to close the Find window and highlight the rst cell in the report that matches the search
value you entered.

◦ Click Find All to close the Find window and highlight all the cells in the report that match the search value
you entered.

8. To nd the next instance of the search value without opening the Find window, click Find on the Home tab.
9. To clear the search value you entered without opening the Find window, click Clear on the Home tab.

How You Use Cached Data in Reports  
Before you analyze data returned in reports, it is benecial to understand how using cached data can aect your
reports.

Some standard reports return data compiled during previous time periods, and you can create custom reports that
use data from tables that store this cached information. Reports that use cached data can query a large amount of
information in a short amount of time since cached data is stored in only a few database tables. Reports that use cached
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data are often designed to compare data from one time period to another, such as comparing sales gures from one
quarter to another.

Agedatabase Utility Data Caching  
Most cached data is compiled by the Agedatabase utility. This utility runs nightly to cache data to prepare for the
following day’s reporting needs. Understanding which reports use cached data will help you accurately interpret your
reports’ results.

Cached data remains constant throughout the day and is not updated until the next day, after Agedatabase has
compiled the information. For this reason, reports using cached data do not include data for the current day.

If you view the report denition for the report you want to run and see that the report includes a database table that
stores cached data, you know the report uses cached information and may not include data from the current day.

Related Topics
• View a Report Denition

• Answer 1917

Dataminer Utility Data Caching  
Some cached data is compiled by the Dataminer utility instead of the Agedatabase utility.

By default, the Dataminer utility runs every four hours or as specied in the VISIT_MAX_TIME conguration seing
(RightNow User Interface/General/Security).

CAUTION:  We do not recommend changing conguration seings unless necessary. Changes made to
conguration seings can greatly impact the performance and functionality of your entire site. Before you
change any conguration seing, it is important that your organization understands the impact of changing
the seing. See Overview of Site Conguration.

The data in the following elds is compiled by the Dataminer utility.

• Answers.Score (answers.solved_count)

• All elds in Answer Stats (ans_stats) table

• All elds in the Links (links) table

• Stats.# Answers Viewed (stats.ans_viewed)

• Stats.# Answer Searches (stats.searches)

• Stats.Visitor Actions (stats.hits)

Information in reports that use these tables or elds is only as current as the last time the Dataminer utility ran.

Overview of Queuing Reports  
Reports can be manually or automatically queued to run at a later time.

Reports, whether opened individually or in dashboards, can take a long time to run if their database queries aempt to
query a large amount of information. However, you can queue reports with intense queries so you can continue to work
on the administration interface while the reports run in the background. When the queued reports have been run, you
can open them and immediately view their data.
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You can manually queue reports that you think may take a long while to run or that you want to view at a later time. If
the application determines that a report will take an excessive amount of time to run, which can result in unnecessary
load on your database, you’re given the option to queue the report using the report’s current search parameters. If you
choose not to queue the report, you can select more restrictive search parameters for your report and try to run it again.

Note:  Reports that aempt to query too many rows in the database will not run. If you queue such a
report, the server will still not be able to process it. We recommend using more restrictive lters, removing
unnecessary tables, and using inner table joins to allow such reports to run.If you need a report to return a
large amount of information, we recommend that you queue it using the Download Queued Report Results
as a CSV File option. This lets you send up to 100MB of data to a comma-separated values (CSV) le. You can
then open the le using an external application.

If your site is congured to use a report database (also referred to as a replication database) for reporting purposes,
queuing works somewhat dierently than it does on sites without a report database. See How Queuing Works on the
Report Database.

Queue a Report or Dashboard Manually  
You can queue reports or dashboards that you think may query or return large amounts of data. This is also helpful if
you want to view a number of reports but do not want to wait for each to generate.

For information about viewing reports in the queue and opening queued reports that have processed, see How You
View Reports in the Queue.

You can also require dashboards and reports to be queued when they are run by enabling the Set Report to Deferred
Execution option. See Change Report Properties.

1. Do one of the following:

◦ Select the report or dashboard on the Reports explorer and click the ribbon’s Queue buon.

◦ Right-click the report or dashboard, either on the Reports explorer or the navigation list, and select
Queue.

The Queue Search Filters window opens where you specify the search parameters you want to use for the
queued report.
The window contains three sections: Filters, which includes Products, Interface, and Date Range selection
options; Delivery Options, which includes options to view or download queued-report results; and Limit and
Order, which includes queued-report display options.

2. Enter the search parameters you want to use.
For information about specifying search parameters, see How You Search in Reports.

3. To send the report output to a CSV le instead of to the console, select the Download Queued Report Results
as a CSV File option.

This lets you send up to 100MB of data to a CSV le. Without this option, reports can return up to 10,000 rows
of data. After the queued report is generated, you can select a location to save the le to and then open it using
an external application. This option is not available when queueing dashboards.

In addition, this option is not available for all reports since not all reports are appropriate for CSV output. The
following restrictions apply.

◦ The report cannot contain custom scripts.

◦ The report cannot contain comparison columns.

◦ The report cannot contain date grouping columns.
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◦ Rows in the report must return unique records, such as information about specic incidents, answers, or
contacts.

◦ The rst column in the report must be sorted in ascending order and must output data stored in a
primary key database column. For instance, the rst column could output incident ID numbers or contact
ID numbers, and be sorted in ascending order. This restriction helps the data queries more quickly
process reports since they use primary keys.

4. Click Queue.
A message displays an approximation of when the report or dashboard will be generated.
The time displayed is an approximation of how long it will take to process the queued report or dashboard.
However, if there are other reports or dashboards in the queue, it can take longer than the displayed time to
process your queued report or dashboard.

5. Click OK.

Automatically Queuing Reports  
You can choose to queue the report using the search parameters you selected.

When you aempt to open a report, the database query for the report is checked. If the system determines that the
query will likely take too long to process, the Unable to Process Report window displays, asking if you want to queue the
report. If you want to aempt to run the report using dierent search parameters, click Cancel. The window will close
and the report’s Search window will open. If you want to queue the report using the search parameters you selected
when you aempted to run the report, click OK. If you do so, a message displays an estimate of how long it should take
to process the report, just as if you had manually queued the report.

Note:  Reports that are displayed on the workspace or previewed on the report designer are never queued. If it
is determined such a report will take too long to generate, the report is not displayed.

How to Prevent Automatic Queuing  
You can prevent the automatic queuing of reports.

After a report is automatically queued, it is queued every time it is run thereafter, since it is assumed the report’s lters
and data set result in long run times.

Tip:  To view reports that will be automatically queued when they are next run, you can run the Deferred
Reports standard report. This report is located in the Reports explorer’s Common > Site Administration >
Reports folder.

If you have a report that is set to be queued, you can prevent it from being automatically queued when it is next run.
However, you will still be asked to queue the report when you next run it if the report meets queuing criteria. See
Change Report Queuing and Data Source Options for information about preventing automatic queuing for a standard
report or Change Report Properties for information about changing queuing options for a custom report.

Tip:  When you change queuing options for a custom report, we recommend that you also review the report’s
xed lters and table joins to determine if the amount of data the report examines can be reduced to allow it
to run more quickly.

Why Reports Fail to Queue  
It is possible that a report you queue will not run successfully.
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There are several reasons why this might happen.

• You already queued the report using the same search parameters and the rst queued report has not yet run.

• The original report you queued was deleted after you queued it and before the queued report could be
processed.

• The report is deleted from the queue by another sta member before the report can run and you can view it.
However, only the sta member who queues the report and sta members with the Analytics Administrator
prole permission can remove reports from the queue.

• The queued report processes, but is not opened within the number of days specied in the
PURGE_QUEUED_REPORT_DAYS conguration seing. Queued reports and dashboards that have been run but
not opened within this time period are automatically removed. The default value for this conguration seing is
seven days.

• You manually queue a report or dashboard that cannot run due to the query surpassing a limit on the number
of database rows that can be accessed.

Notications for queued reports that fail to run include information about the cause of the failure. If the recipient has
permission to edit the report that failed, links to the report analyzer are also included. See Troubleshoot Reports Using
the Report Analyzer.

How You View Reports in the Queue  
Reports placed in the queue are associated with one of the following states: Waiting, Processing, and Complete.

When you queue a report, it is placed in a queue where it will be processed by the server. If there are other reports in
the queue that have not yet been processed, your report will be placed at the end of the queue. You can see the reports
that are in the queue using the My Queued Reports and Reports Waiting in Queue standard reports. From the Reports
Explorer, click  Public Reports > Common > Site Administration > Reports  folder:

• Reports Waiting in Queue—Displays all the reports that are in the queue waiting to be processed, regardless of
who queued the report. Sta members with the Analytics Administrator prole permission can remove reports
from the queue using this report if necessary.

• My Queued Reports—Displays the reports you have queued and not yet viewed. When you view this report,
you will see that queued reports can be in one of three states.

◦ Waiting—Reports in this state are waiting to be run on the server. You can remove reports from the
queue that are in this state.

◦ Processing—Reports in this state are currently being run on the server. You cannot remove reports from
the queue that are in this state.

◦ Complete—Reports in this state have been run on the server and are ready to view. You can remove
reports from the queue that are in this state without viewing them.

How You Open Queued Reports  
You can open queued reports from My Queued Reports or from the notications list.

When the database server has run a queued report and it is ready to view, you will receive a message in a toast
notication and in your list of notications. See Notications.

To view the report, click Open on the toast notication or double-click the notication in your notications list. The
report opens on the content pane. You can also open reports you queued from the My Queued Reports standard report.

When you open a queued report that was sent to a CSV le, the Save As window opens where you can select a location
to save the CSV le. You can then use an external application to view the contents of the le. See Queue a Dashboard
Manually.
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Note:  After a queued report is processed, you have a default of seven days to view it. Reports older than the
time period specied in the PURGE_QUEUED_REPORT_DAYS conguration seing (Agedatabase/Batch
Processing/Miscellaneous Purging) are deleted from the list of processed reports by the Agedatabase utility.
For information about this and other conguration seings that impact reports, see Analytics Conguration
Seings.

How You Use Queued Reports  
When you open a report that you queued, it displays and functions just like a report that has not been queued.
However, there are some dierences to be aware of.

• Docked lters are not displayed in queued reports.

• Action links, such as those used to open and delete records, are not displayed.

• The ribbon’s Search, Refresh, Reset, Denition, and Links buons are not available.

• If your report includes drill-down levels, these levels are not queued, so are instead run when you open the
drill-down levels.

You can view the output from a queued report as many times as you want. However, it is important to remember that
the output is static. If you need current information from the report, you need to run or queue the report again.

Overview of Report Databases  
Most Oracle Service Cloud sites have a copy of their database, called a report database, available for reporting purposes.
(Report databases are also referred to as replication databases.)

Running reports on this database is generally faster than running reports on the operational database where normal
activities, such as adding and editing incidents, occur. In addition, since report databases are used only for reporting,
they have higher thresholds on the amount of time reports are allowed to run and the number of database rows reports
are allowed to query.

Note:  Reports that you aempt to run on the report database can still encounter limits on the number
of database rows that can be queried, though the row limits are considerably higher than those on the
operational database.

A report that does not run successfully on your operational database may run successfully on your report database.
However, since the data on report databases is copied from the operational database at xed times, the data displayed
on reports run on report databases may not be as current as the data shown on reports run on operational databases.

How You Specify Which Database Reports Run On  
You can specify whether you want a report to always run on the operational database or the report database. The
system can also automatically force a report that fails to run on the operational database to instead run on the report
database.

By default, reports are congured to run on the operational database. However, they can automatically switch to the
report database (also referred to as the replication database) if they cannot run on the operational database. When
you aempt to run a report, the system reviews the database query generated by the report. If it is determined that the
query will take longer than 10 seconds to run or will query more than 2,000,000 database rows, the report automatically
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runs on the report database. Reports run on this database can query up to 5,000,000 rows. The report owner receives a
notication if their report is changed to run on the report database.

Note:  When reports are run from editors, such as the incidents editor or the Quick Search menu, they run on
the operational database regardless of the reports’ conguration. In addition, reports that include the Fill Inbox
record command always run on the operational database. See Change Record Command Actions.

After a report is modied, either manually or automatically, to run on the report database, it will continue to do so
unless you edit the report and specify that it runs on the operational database. You can also specify that the report
always runs on the database you select to avoid the report automatically changing to run on a dierent database. In
addition, you can require that the report is queued or not queued when it is next run.

Change Report Queuing and Data Source Options  
You can change the queuing and data source options for reports and dashboards.

The Administrator Analytics prole permission is required to modify these seings on a standard report or dashboard.
See Analytics Permissions.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Navigate to the report or dashboard you want to modify, right-click the report, and select Edit.
4. Open the Edit Seings window using one of the following options:

◦ To open the window for a standard report or dashboard, click More Options.

◦ To open the window for a custom report or dashboard, click Options, and then select More Options.

The Edit Seings window opens.
5. To require the report or dashboard to be queued when it is next run, select Set Report to Deferred Execution.

See Automatically Queuing Reports.
If this option is not selected but the report or dashboard is automatically queued the next time it is run due to
meeting queuing criteria, the Set Report to Deferred Execution check box is selected automatically. Clear this
check box to prevent the report or dashboard from being automatically queued when it is next run. However,
even when this check box is cleared, you will still be asked to queue the report or dashboard when you next run
it if it meets queuing criteria.

6. Select the database you want the report to run on.
a. To run the report or dashboard on the operational database, select Operational Database. This option is

helpful if you need the most current data available.
b. To run the report or dashboard on the report database, select Report Database. This option is helpful if

your report queries a large amount of data since the query size restrictions on report databases are more
relaxed than those on operational databases.

7. Click OK.
8. Click Save.

How Queuing Works on the Report Database  
Report queueing works slightly dierently when using the reporting database.

Since sites with report databases (also referred to as replication databases) have additional options available for running
reports, queuing works slightly dierent on those sites. If your site has a report database, you’ll want to consider keep
the following in mind when queuing reports.

• Any reports you queue automatically run on the report database unless the report is congured to always run
on the operational database. You can select this option when editing the report. See Change Report Properties.
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• If a report is to be run on the report database and it is determined it will take longer than sixty seconds to run
the report’s query, you’re given the option to queue the report. If you choose not to queue the report, you can
aempt to run it again using dierent search parameters. See How You Search in Reports.

How You Distribute Reports and Dashboards  
You can share reports with others in a number of ways.

After you open a report or dashboard, you can print it, forward it to an email address, publish it to your folder list, or
export the data to be used in an external application. You can also schedule reports and dashboards to be published or
emailed at specied times, or when specied data conditions are met. If you have another interface and want to create
a copy of your report or dashboard on the other interface, you can also export the denition and import it on the other
interface.

In addition, frequently-used reports and dashboards that query large amounts of information can be cached at
scheduled times to reduce database load that can adversely impact site performance.

Note:  Before you can print, export, or forward reports or dashboards, the Print/Export/Forward Reports
permission must be enabled in your prole. See Analytics Permissions.

Modications Made to Distributed Reports  
When reports and dashboards are exported, forwarded, printed, published, or sent at a scheduled time, certain changes
are made to ensure that they display correctly.

Reports and dashboards you open outside Oracle Service Cloud may not display exactly as they do when viewed within
the application.

• Drill-down links to other reports, dashboards, or report levels are disabled in distributed reports. See Overview
of Report Output Levels for information about drilling down into report levels and Overview of Linked Reports
for information about drilling down into other reports or dashboards.

Note:  If your report includes multiple output levels, drill down to the information you want to display in the
distributed report before you export, forward, or publish it.

• If the report includes the Links column, which contains links to modify the report’s records, the column is not
shown on the report.

• If the report’s width is set to Fit in Window, the report is shown using the Best Fit width seing. See Change
Page Options for descriptions of these seings.

• Reports shown in the record layout are by default converted to tabular layout when they are exported or
scheduled in an Excel format. This ensures that the report’s data can be easily read in a column and row format.
See Display Data Using Record or Tabular Layouts for information about layouts.

• If the report lacks a report header or has a blank header, a header containing the report’s name is added to the
report.

• If the width of a report column is set to a percentage of the report’s width, and the report’s width is not xed,
the column’s width seing is changed to Best Fit. See How You Edit Column Formaing for information about
column width seings.
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• Forwarded and scheduled reports sent in an HTML format use a relative layout instead of an absolute layout.
This ensures maximum compatibility with various browsers, but may impact the display of images or charts in
the email.

• Paging is disabled for published reports. See Add Page Breaks.

• The dates and times displayed in scheduled reports are adjusted for the time zone of the interface they are sent
from, but aren’t adjusted for sta members’ time zone seings in their sta accounts. See Overview of Sta
Management and How You Schedule Reports.

• Externally hosted images displayed in columns aren’t available in scheduled reports. See Display External
Images in a Report Column.

Print a Report  
After you run a report, you can preview it to see how it will look on a printed page and then send it to a printer.

When previewing a report, you can zoom in and out of the displayed page, view multiple pages, and specify how the
pages should display in the preview window. Before you print the report, you can specify print options, including paper
size, margin width, and page orientation.

1. Open the report you want to print and click the Page Setup tab.
2. To automatically scale the report to your printer’s default page width, select Print to Fit.
3. Do one of the following:

◦ To specify page setup options, such as page margins, click the buon to the right of the Print group
name to open the Page Setup window where you can set printing options.

◦ Select printing options from the Page Setup tab’s Print group. See Report Designer Page Setup Tab for
option descriptions.

Tip:  If you know the specic options you want, it can be faster to select them from the ribbon.
Opening the window gives you an overview of all the available options.

4. Enter eld information.

Field Description

Paper
 

This section contains options for selecting paper size and source.
 

Size
 

Click the appropriate paper size for the report from this drop-down menu. The available
paper sizes depend on your selected printer.
 

Source
 

Click the paper source from this drop-down menu. The available paper sources are
dependent on the printer that is currently selected.
 

Orientation
 

Select whether the report should be printed in landscape or portrait mode.
 

Margins
 

Dene the Left, Right, Top, and Boom margins for the report.
 
The measurement units used for the margin size are determined by your workstation’s
environment.
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Field Description

Printer
 

Click this buon to select the printer you want to use.
 

5. Click OK.
6. Click File, select Print, and then do one of the following to select your printing preference.

a. Select Print to open your workstation’s print window where you can dene printer seings and send the
report to the printer.

b. Select Quick Print to send the report directly to your default printer using the printer’s default seings.

Preview a Report  
You can preview the information on a report before you print it.

1. Open the report you want to preview.
2. Click File and select  Print > Print Preview .

The Print Preview window opens.
3. Select the preview options you want.

Field Description

Print Click this buon to send the report to the printer.

Zoom Click the down arrow to select the desired zoom percentage and preview the report with
the selected zoom level. Click the magnifying glass to reset the zoom level to the default
percentage.

Page Click these buons to view one, two, three, four, or six pages of the report on the Print
Preview window. These options do not modify the nal printout.

Close Click this buon to close the Print Preview window without printing the report.

Page Enter the page number you want to view on the Print Preview window, either by
entering the page number or by scrolling through the available page numbers with the
arrows.

Forward a Report  
You can forward reports and dashboards in emails.

After you view a standard or custom report, you can immediately forward the report as an HTML email to one or more
recipients. You can also forward dashboards using the same procedure. Certain modications may be apparent when
viewing forwarded reports.

Note:  You can forward reports as long as the resulting HTML email does not exceed 8 MB.

1. From an open report, click the Home tab.
2. Click Forward.

The Forward Report window opens.
3. Do one of the following:
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◦ Type one or more email addresses in the To eld. Multiple addresses must be separated by semicolons.
You can also enter addresses in the Cc eld to send copies of the email to other addresses, or enter
addresses in the Bcc eld to send copies of the email to other addresses that are hidden from the other
email recipients.

◦ Click To, Cc, or Bcc to open the Select Names window. From this window you can add recipient addresses
by selecting from a list containing sta members, groups, and distribution lists. See Select a Recipient.

4. Select a format for the forwarded email. Options include HTML Email or HTML Aachment (Images/Charts
stored on the server).

Not all email clients show HTML emails in the same manner. If email recipients cannot view a forwarded report
correctly, select the HTML Aachment (Images/Charts stored on the server) format. Email recipients can then
save the image or chart to their hard disk and then open it in a browser. The images and charts used in the
email are stored on the server for the number of days specied in the KEEP_EMAILED_IMAGES conguration
seing. See Analytics Conguration Seings for information about this and other conguration seings that
impact reports.

5. Enter a subject for the email.
6. Enter any text you want to appear in the email in the Comment text box.
7. Click Send.

Related Topics
• Modications Made to Distributed Reports

How You Publish Reports  
Publishing a report lets you modify the data and display options of an existing report and then save a copy of the report
in the reports explorer that other individuals can access.

After a report is published, it cannot be modied and the report data remains unchanged even as the knowledge base is
updated. This ensures that your audience is presented with the report as you want them to see it.

Note:  To open a published report, sta members must have permission to access the report in the reports
explorer folder where it is placed. You can change report permissions by editing the published report, or by
editing Analytics permissions in the prole. See Set Report Permissions.

The published report appears exactly as it appeared when you published it, with the following exceptions.

• Drill-down links are disabled for report levels and linked reports.

• The report’s runtime selectable lters are not available.

• Actions that can be taken on individual records in the report are disabled. Therefore, buons on the Home tab’s
Record group are not available, inline editing is disabled, and action links are not displayed.

• Paging is disabled for published reports. See Add Page Breaks.

• The Publish option is not available.

• If the report style the report used when it was published is deleted, a default report style is used when
rendering the published report.

You can also automatically publish a report at specic times using the Published format when you schedule a
report. Published reports created in this manner are saved in a custom reports folder you select on your site where
your audience can access them. If you specify an account or email address when you create the report schedule, a
notication or email is sent when the published report is created.

The following procedure describes how to manually publish a report. For information about scheduling a report using
the Published format, see How You Schedule Reports.
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Tip:  You can view the published reports you own using the My Published Reports standard report.

Publish a Report Manually  
You can manually publish a report and save it.

1. Run the report you want to publish using the same search parameters that you want the published report to
use.

2. Click  File > Publish .
The Publish As window opens.

3. Select a directory to store the published report and enter the name of the report.
The name must be unique.

Tip:  You can right-click non-standard folders and select New Folder to create a new folder.

4. Click OK.

Export Report and Dashboard Data  
The data shown in reports and dashboards can be exported to several dierent le formats so you can view the data
in third-party applications. The information that is exported and opened in third-party applications is subject to the
functionality of those applications.

You can export your data to HTML, PDF (Portable Document Format), Excel, XML (Extensible Markup Language), Image,
or Delimited formats. You can also export the report output to the clipboard. When viewing a report, a maximum of
50,000 characters can be displayed in a single eld even if the eld contains more characters than this. However, up
to 300,000 characters in a eld can be exported, though character limitations in third-party applications may still be
encountered when viewing the exported report.

Tip:  If you want to copy the contents from a few cells in your report or dashboard to another application, you
do not need to export the data. Instead, you can right-click the cell you want to copy and select Copy Cell to
Clipboard. After the data is on your clipboard, you can copy the data to other applications.

1. Run the report or dashboard to display the data you want to export.
2. Click Export on the Home tab.

A menu of export options displays.
3. Select the type of export le that you want.

Field Description

HTML
 

This option exports the data to an HTML-encoded document, which is compatible with
exporting images and charts. Reports and dashboards can be exported using absolute
or relative HTML layouts. See Export Report and Dashboard Data for descriptions of
export options.
 

PDF
 

This option exports the data to a PDF le, which is compatible with exporting images
and charts. When you select this option, you can choose to set the le’s page width
automatically or use the options on the Page Setup window.
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Field Description

Excel
 

This option exports the data to a Microsoft Excel le.
 
When exporting in this format, the version of Microsoft Excel installed on your
workstation is automatically checked and the data is exported to an .xls or .xlsx le
depending on the version.
 

XML
 

This option exports the data to an XML le.
 

Image
 

This option exports the data to a .jpg image le, which is compatible with exporting
images and charts.
 

Clipboard
 

This option exports the data to the workstation’s clipboard. The data can be exported to
the clipboard in HTML, Tab Delimited, or Comma Delimited formats. After the data is on
the clipboard, it can be copied to other applications.
 

Delimited
 

This option exports the data to a character-delimited le. When you select this option,
the Delimiter Selection window opens, where you can specify the character you want
to use as the delimiter. You can choose Comma, Space, Tab, Pipe, Caret, or a custom
delimiter you select. The delimited format is intended for use with tabular data only.
 

When you select a format (with the exception of the Clipboard format), the Export Options window opens
where you can specify the le name and save location, whether to include the report or dashboard name, and
whether all the data should be returned or only data shown on the current page. The HTML, PDF, and custom
delimiter export options include additional export options.

4. Select the options you want applied to the export le.

Field Description

Location
 

This eld displays the le name and where it is saved to. When the Export Options
window is initially opened, a default directory location and le name is displayed.
 

Save to Folder (folder icon)
 

Click this buon to open the Save As window if you want to specify an alternate location
or le name.
 

Launch Application
 

Select this check box to automatically launch the application associated with the le
type the data is saved to when you close the Export Options window.
 
If you’re exporting a large amount of data, you may want to clear this check box to
prevent the application from aempting to immediately open when you export the data.
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Field Description

Append Date/Time to File Name
 

Select this check box to append a date/time stamp to the le name that shows when the
export le is generated. The date/time stamp is appended to the end of the le name
before the le name extension.
 

Date/Time Format
 

Enter the format you want to use for the date/time stamp you append to the export
le name. The default format is %Y-%m-%d %H.%M.%S. This creates a date/time
stamp with the year listed rst, followed by the month, day, hour, minute, and second
(such as 2012-02-25 09.43.30). The format you specify is automatically saved to your
personal seings so this becomes your default format the next time you export a report
or dashboard. See Reference Information.
 

Reset
 

Click this buon to reset the date/time format to the default format (%Y-%m-%d %H.
%M.%S).
 

Save the Selected Directory as the
Default Directory
 

Select this check box to make the folder you specify your default export directory.
Selecting this check box saves the folder name to your personal seings so future
exports are saved to the specied folder.
 

Add Report Name to Output
 

Select this check box to include the report’s name in the export le.
 
This option is not available when exporting dashboards. Report names display in
exported dashboard les if their title bars are enabled in the dashboard’s display
options. See Edit Dashboard Options for information about including report title bars on
a dashboard.
 

Data Set
 

The options in this group let you choose to export all the data returned by the report’s
current search criteria or only data shown on the report when the Export buon is
clicked.
 
Data Set options display only if the report’s output is restricted by record limits, page
limits, slicing, or auto-lters when the Export buon is clicked. This option is not
available when exporting dashboards, published reports, or queued reports.
 

Export Current Page
 

Select this option to export only the data currently shown on the report.
 

Export All Data
 

Select this option to include all the data from the report, up to 100,000 rows, regardless
of the report’s current record limits, page limits, slicing, or auto-lters seings.
 
This option is not functional for reports that were queued.
 

HTML Options
 

Select how you want the HTML le to be generated in this section.
 
This section displays only when you select HTML format.
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Field Description

 

Use Absolute Layout
 

Select this option to format the export le using absolute layout. The exported report or
dashboard will match the display of the original very closely, though discrepancies may
be noticed in some reports and dashboards.
 
Some browsers do not support printing HTML les that use this layout.
 

Use Relative Layout
 

Select this option to format the export le using relative layout. The exported report or
dashboard will be similar to the original, though there may be some discrepancies.
 
Most browsers support printing HTML les that use this layout.
 

PDF Options
 

Select how you want to specify the width of the PDF document in this section.
 
This section displays only when you select PDF format.
 

Set Page Width to Best Fit the
Report
 

Select this option to automatically set the width of the PDF le to best t the width
of the report or dashboard. This method displays the report or dashboard in its
original width, though the size of fonts may be reduced and the le may use landscape
orientation to t wide reports and dashboards.
 

Use Printer Page Setup to Set Page
Dimensions
 

Select this option to open the Page Setup window to manually select margins, paper
size, and orientation for the PDF le. Print a Report for information about this window.
 

Excel Options
 

Select how you want to format date/time columns for the Excel le in this section.
 
This section displays only when you select Excel format.
 

Convert All Dates into Excel
Formaed Dates
 

Select this check box to convert all the date and time values shown in the report’s
columns to Excel’s MM/DD/YYYY HH:MI AM/PM date format. Selecting this option
ensures the date columns in the exported data is consistent with Excel’s functionality.
 

Include Cell Images
 

Select this check box to include images that are displayed in the report’s or dashboard’s
cells in the exported le.
 
This option is selected by default.
 

Custom Delimiter
 

Enter the custom delimiter you want to use in this eld. This option displays only when

you select the Delimited > Custom format.

 

5. Click OK.
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If you selected the Launch Application check box, the application associated with the exported le’s le type
opens.

Related Topics
• Run a Standard Report (video)

How You Schedule Reports  
Scheduled reports are a list of reports that are set up to run on a specied schedule.

You can schedule reports to be sent by email to yourself, other sta members, email addresses, or distribution lists. You
can also create a schedule to automatically publish a report. When you dene a schedule, you dene the specic times
when you want the report to be sent. You can also specify the values you want for the report’s lters and variables.

Certain modications may be apparent when viewing reports or dashboards sent in emails. See Modications Made
to Distributed Reports. In addition, if scheduled reports include custom scripts, the scripts must contain initialization
information to ensure they run correctly when recipients open the reports. See Create a Custom Script in a Report.

If you need a report sent when certain conditions are met, you can create alerts. Alerts send the scheduled report when
criteria you dene in data exceptions are met. For example, you can create data exceptions to ag incidents that have
not been responded to in 24 hours, and then create an alert to send the report when the data exceptions are met. See
Add an Alert to a Schedule.

Note:  The Create/Edit Reports Analytics prole permission must be enabled to schedule reports. See
Analytics Permissions. In addition, scheduled reports are available only when the option is enabled. For
information about enabling scheduled reports, contact your Oracle account manager.

Schedule a Report  
You can set up reports to run on a specied schedule.

1. Open the Scheduling window (for standard reports) or Schedules window (for custom reports).
a. To schedule a standard report, right-click the report and select Edit. The Scheduling window displays on

the left side of the content pane, and displays information about any schedules for the report that have
been created.

b. To schedule a custom report, right-click the report and select Edit. Click the Home tab, and then click
Scheduling. The Schedules window opens, showing schedules that have been created for the report.

2. Click Add Schedule.
The New Schedule window opens.

3. Enter a name for the new schedule in the Name eld.
The name should clearly identify the purpose of the schedule. When creating a schedule to publish a report, the
report that is created in the destination folder is given the name you specify in the Name eld.

4. Specify the email recipient (unless using the Published format), using one of the following methods:

◦ Enter the email addresses the scheduled report email should be sent to in the To eld. Separate
addresses with semicolons.

◦ Click To. The Select Recipients opens where you can add sta members, groups, and distribution lists to
the schedule. See Select a Recipient.

Note:  Emails sent for scheduled reports automatically hide the other recipients’ email addresses in
the email header.

5. Enter a subject for the scheduled report email in the Subject eld.
6. Enter any text you want to include in the body of the scheduled report email in the Comment eld.
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7. Select the format of the report from the Format drop-down menu.

Format Description

HTML Aachment (Images/Charts
stored on the server)
 

Select this option to send the report in an HTML le aached to an email. Images and
charts displayed in the report are stored on the server, leing recipients who have
access to the server view them.
 

HTML Email (Images/Charts stored
on server)
 

Select this option to send the report as an HTML email. Images and charts displayed in
the report are stored on the server, leing recipients who have access to the server view
them.
 

HTML Email (Images/Charts sent in
email)
 

Select this option to send the report as an HTML email that includes the report’s images
and charts. This lets recipients who do not have access to the server view the report’s
graphics.
 

Excel Aachment (Images/Charts
unavailable)
 

Select this option to send the report output in an Excel le aached to an email. The le
does not include the report’s images or charts.
 

Comma Delimited Aachment
(Images/Charts unavailable)
 

Select this option to send the report output in a comma-delimited text le aached to
an email. The le does not include the report’s images. or charts.
 

XML Aachment (Images/Charts
unavailable)
 

Select this option to send the report output in an XML le aached to an email. The le
does not include the report’s images. or charts.
 

Image Aachment
 

Select this option to send an image of the report in a le aached to an email. This lets
recipients view the report as it displays in the console, but does not let them work with
data.
 

PDF Aachment
 

Select this option to send the report in a PDF le aached to an email. This option
includes images and charts.
 
Non-English characters may not display correctly when sent as a PDF aachment. We
recommend instead using an HTML format for such reports.
 

Published
 

Select this option to publish the report at the scheduled time. See How You Publish
Reports.

Note:  The Published format does not require email information.
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Format Description

Compressed CSV File
 

Select this option to send the report in a compressed CSV le aached to an email. The
recipient can then open the le using third-party software. Images and charts are not
available when using this option.
 
Since this option reduces the amount of processing required to run the report, you can
send reports that return up to 100MB of data. Without this option, reports can return a
maximum of 10,000 rows.
 
There are restrictions on the reports that can be sent to CSV les since not all reports
are appropriate for such les.
 

◦ The report cannot contain custom scripts.

◦ The report cannot contain comparison columns.

◦ The report cannot contain date grouping columns.

◦ The report’s rows must return unique records, such as information about specic
incidents, answers, or contacts.

◦ The rst column in the report must be sorted in ascending order and must output
data stored in a primary key database column. For instance, the rst column could
output incident ID numbers or contact ID numbers, and be sorted in ascending
order. This restriction helps the data queries more quickly process reports since
they use primary keys.

This option is not available for reports that do not meet these requirements.
 
When sending a large CSV le in an email, the le size limits congured on the
recipient’s mail server may prevent delivery of the le. If you encounter this issue, you
can queue the report to save it in a CSV le instead. See Overview of Queuing Reports.
 
This option is not available when scheduling dashboards.
 

Send Report to Report Queue for
Delivery as a CSV File
 

When you select this option, the report is queued at the scheduled time. However,
 instead of being sent as an email aachment, the CSV le is accessed in the report
queue. You can access the queued report from toast notications or the My Queued
Reports standard report. See How You View Reports in the Queue.
 

8. To select the folder in the Reports explorer where you want published reports sent, click the Destination Folder
drop-down menu and select the folder you want as your destination. This drop-down menu is available only
when you select the Published format. See How You Publish Reports.

9. From the Run Report As drop-down menu, select the sta account that would be used if the report were run
manually. This lets you specify which account should be used in reports that use the “logged in” lter value.

Since the time zone used in the report depends on the account that runs the report, this impacts the times
shown in the report. For example, if a sta member working in the Pacic time zone runs a report, the times
shown in the report are adjusted to display in the Pacic time zone. See Add or Edit a Sta Account.

10. Click the schedule time next to the Recurrence eld. The Schedule Recurrence window opens. The underlined
text displays the report’s current schedule. This is set to Every Day Every Hour by default.

11. Enter eld information.
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Field Description

Schedule Times
 

Select the times of the day from this menu when the scheduled report should be sent.
The available times include fteen-minute intervals, so a report could be scheduled to
send at 6:15 A.M. and 4:45 P.M.
 

Every Hour
 

Click this text to automatically select all the hourly check boxes.
 

Clear All
 

Click this text to clear all selected schedule time check boxes.
 

Recurrence Paern
 

Select the weekly or monthly interval when the report should be sent. For example, a
report could be sent every two weeks on Tuesday, or every month on the 7th and 19th.
 

Clear All
 

Click this text to clear all selected recurrence paern check boxes.
 

Monthly
 

Select this option to display check boxes for the days of the month. You can then select
the days of the month when the report should be sent.
 

Weekly
 

Select this option to display check boxes for each day of the week. You can then select
the check boxes next to the days when you want the report to be sent.
 
When you select this option, a Recur drop-down menu displays where you can specify
the frequency of the weekly report. For example, if you want the report sent every week
on the days selected, enter 1 in the eld. If you want the report to be sent every third
week on the days selected, enter 3 in the eld. This eld accepts values from 1 to 99.
 

Schedule Specic Months
 

Click the Schedule Specic Months header to display check boxes for the months of the
year. Select the months during which the scheduled report should be sent. By default,
 every month is selected, but if you do not want the report sent during a specic month,
 you can clear the check box for that month.
 

Clear All
 

Click this text to clear all check boxes for the selected months.
 

Range of Recurrence
 

Options in this section let you specify a date range during which the scheduled report is
sent.
 

Start
 

Enter the start date of the schedule or click the Calendar buon to open a calendar from
which you can select the start date. The current day is the default start date.
 

End
 

Enter the end date of the schedule or click the Calendar buon to open a calendar from
which you can select the end date.
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Field Description

 

12. Click OK.
13. To specify the values you want to use for the report’s lters and variables when the scheduled report is sent,

click the underlined text next to Filter Values. The Search window opens where you can select the values for the
report’s runtime lters to use when the scheduled report is automatically generated.
If you do not specify lter values, the report’s default values are used. See Overview of Report Filters.

Note:  The Ordering feature is not available when selecting lter options for scheduled reports.

14. Click OK.
15. To edit an existing schedule, click Edit next to the name of the schedule on the Scheduling or Schedules

windows.
The Edit Schedule window opens. The options in the window are identical to those in the New Schedule
window.

16. To delete an existing schedule, click Delete next to the name of the schedule on the Scheduling or Schedules
windows.

a. Click Yes to conrm the deletion.

Related Topics
• Run a Standard Report (video)

Add an Alert to a Schedule  
If a report includes data exceptions, you can create an alert to send an email when the data exception criteria is met.

You can also specify how many times in a row the exception must be met before the alert is sent. The report’s data
exception is checked at the times specied in the report’s Schedule Recurrence window. For instance, a report’s data
exceptions could be congured to trigger when ten incidents returned in the report meet the criteria you specify, such
as the incidents’ response times not being met. You could then congure a schedule for the report to trigger once an
hour every work day. After the schedule is created, you could create an alert to be sent if the data exception is met twice
in a row. This would result in the report’s data exception being automatically checked once every hour each work day,
according to the times specied on the Schedule Recurrence window. If the report’s data exception is met a single time,
the alert would not be sent. However, if the data exception was also met when it was next checked, the alert email would
be automatically sent.

The Alerts section of the New Schedule window displays email alerts and their aributes, and lets you create new alerts.
Alerts are disabled if the report does not include data exceptions, since alerts are based on data exceptions being met.
See Create a Data Exception.

1. Open the New Schedule window, as described in Schedule a Report.
2. Do one of the following:

◦ Enter the email addresses to send the alert to, separated by semicolons.

◦ Click To. The Select Names window opens where you can add sta members, groups, and distribution
lists to the alert. See Select a Recipient.

Note:  A report schedule needs to be created in order to add an alert. If the report should be sent
as a regular scheduled report and as an alert, you must add recipients to both the schedule’s To
eld and the alert’s To eld. However, if the purpose of the schedule is only to send an alert, do
not add recipients in the schedule’s To eld.
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3. Click Add Alert to open the Add Alert window.
4. Enter information for the alert.

Field Description

Name*
 

Enter a name for the alert.
 

Exception
 

Click this drop-down menu to select the data exception that is used to trigger the alert.
The options that are listed in the menu are those that have been added to the report.
 

Rule
 

Enter the number of consecutive times the data exception must be met before the alert
is triggered.
 

5. Click OK.

Cache Reports and Dashboards at Scheduled Times  
Caching reports and dashboards that require large database queries can signicantly improve report performance.

Running reports and dashboards that pull large amounts of information from multiple database tables can strain
database resources. If several users need to run such reports and dashboards regularly, the resulting load can adversely
impact site performance. Caching these reports and dashboards on a schedule can greatly reduce the load on the
database while providing recent data for your reporting needs.

You can specify when you want your reports or dashboards cached. By default, they are cached hourly, though you can
set caching intervals as short as fteen minutes. Cached reports or dashboards are run on the server at the specied
caching time. When a user needs to access the report or dashboard, they open it as they normally would. However, the
report or dashboard they see is the version that was cached earlier. At the next scheduled caching time, the report or
dashboard is run on the server again, replacing the previous version.

1. Click Analytics on the navigation pane.
2. Double-click Reports Explorer.
3. Navigate to the report or dashboard you want to cache, right-click the report or dashboard, and select Edit.
4. Click Caching on the Home tab.

The Caching Options window opens.
5. Enter eld information.

Field Description

Enable Results Caching Select this check box to cache the report or dashboard at scheduled times. The other
elds on the Caching Options window are disabled when this check box is cleared.

Schedule Times
 

Select the times of day that you want the report or dashboard data to be cached. You
can click the plus signs next to the hour menu items to view and select fteen-minute
intervals.
 

Select All
 

Click this text to automatically select all hourly intervals. Fifteen-minute intervals are not
selected when you click this.
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Field Description

Clear All
 

Click this text to clear all times that have been selected.
 

Recurrence Paern
 

Select the weekly or monthly caching intervals in this section.
 

Clear All
 

Click this text to clear all selected recurrence paern check boxes.
 

Monthly
 

Select this option to display check boxes for each date in a month. You can then select
the dates of the month you want caching to occur.
 

Weekly
 

Select this option to display check boxes for each day of the week. You can then select
the check boxes next to the days you want caching to occur.
 
When you select the Weekly option, a Recur drop-down menu displays where you
can specify which weeks you want caching to occur. For example, if you want a report
cached every week on the selected days, enter 1 in the eld. If you want the report
cached only every third week on the selected days, enter 3 in the eld. This eld accepts
values from 1 to 99.
 

Schedule Specic Months
 

Click this text to select the months you want caching to occur. By default, every month is
selected, but if you do not want caching to occur during a specic month, you can clear
the check box for that month.
 

Clear All
 

Click this text to clear all check boxes for the selected months.
 

6. Click OK.

How You Change Report Formaing  
When viewing a standard or custom report, you can change the report’s appearance and how data is displayed.

You can change the report’s colors, fonts, and other display options. You can also change formaing options to sort
content, hide columns, add page breaks, and lter data to display only a subset of the records the report returns.

You can also change how data displays on the report using slicing, cross tabs, and rollups. You can also display guided
assistance response data in a tree format to help you beer review the ow of guided assistance responses.

Note:  Your prole must include the Customize Reports Analytics permission to use these options.

Related Topics
• Analytics Permissions
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Apply a Style to a Report  
Styles can be applied to reports to change how the report text and background are displayed.

The fonts, colors, backgrounds, spacing, padding, and borders for the dierent report areas can all be changed by
applying a style. If the style is associated with a chart style, the appearance of charts added to reports can also be
modied.

You can use one of the predened styles, edit an existing style, or create your own style and save it to use immediately
or for reports you view in the future. For procedures on editing and creating styles, see Styles Explorer.

Styles you create or default styles can be applied to any report you view. The style you apply to the report impacts
the report’s appearance when you print it, export it in certain formats, and forward it to others. There are a number of
default styles to choose from. When creating a report for use on the Browser User Interface, we recommend using the
Web Theme style which is formaed for use with web browsers.

1. From an open report, click the Display tab.
2. Click Auto Format.

The Auto Format window opens.
3. To prevent the style from being applied to other levels in the report, clear the Apply Style to All Report Levels

check box.
4. Click the style you want to use.

The report is updated to use the style you select.

Display Data Using Record or Tabular Layouts  
Reports can be displayed using a record or tabular layout.

Most reports use tabular layouts with column headers across the top of the report and data listed in rows beneath
the column headers. However, you can use a record layout to reformat the report to remove the column headers and
instead display the eld names inline with the eld’s values from each record returned in the report. An incidents report
is displayed here with the record layout.

Note:  When a report total is included in a report with a record layout, the total is shifted to the left of the
column that it totals. In addition, since reports displayed in a record layout do not have columns, some options
that apply to columns, such as column width, do not apply.

1. From an open report, click the Display tab.
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2. Click Data.
3. To display the report with a record layout, select Display Data in a Record Layout.
4. To display the report with a tabular layout, select Display Data in a Tabular Layout.

How You Change Report Display Options  
Report styles let you change the display options for specic areas of a report, such as the title or data areas.

If you want to change the margins, width, background, and borders of the entire report, or change how the report
output is displayed, you do so by changing the report’s display options. These are modied using buons on the ribbon
or by using the tabs on the Display Options window.

Related Topics
• Overview of the Report Ribbon

Change Page Options  
The Page Options tab on the Display Options window contains seings which control report width and the margins
surrounding the report content.

1. From an open report, click the Page Setup tab.
2. Click the buon to the right of the Display group name.

The Display Options window opens with the Page Options tab selected.
3. Enter eld information.

Field Description

Report Width 
 

Dene the width of the entire report using the available options.
 

Best Fit
 

Select this option to display the report columns within the width of the window if
possible. If data would otherwise be truncated, the width of the report spans beyond the
open window and a scroll bar is added to the boom of the page, allowing you to view
the entire width of the report.
 
When using this option, all content in the report is examined to calculate column width
before the report displays. To reduce the report load time, select the Improve Display
Performance data display option. See Change Data Display Options.
 

Fit in Window
 

Select this option to display the report columns within the width of the window. This can
result in column names and data being truncated.
 

Specic Width
 

Select this option to manually specify the report width in pixels, inches, or centimeters.
 

Margins
 

Dene the left, right, top, and boom margins for the report.
 

4. Click OK.
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Change Data Display Options  
You can select data display options to control a number of features that modify how data in your report displays.

For example, you can add or remove row numbers and add links to the report, which allow sta members with
appropriate permissions to modify records returned in the report. You can also output report data in a record format.

1. From an open report, click the Page Setup tab, and then click the buon to the right of the Display group name.
The Display Options window opens.

2. Click the Data Display Options tab.
3. To format the report in record layout, select Display Columns in a Record Layout. See Display Data Using

Record or Tabular Layouts.
4. To x the report’s column headers at the top of the report so they are always visible when scrolling the report,

select Fix Column Headers.
5. To add row numbers to each row of the report, select Display Row Numbers.
6. To display multiple calculations in the report on separate lines, select Display Calculations on Separate Rows.

If this check box is not selected and the report displays more than one calculation, the calculations display on
the same line.

7. To reduce processing time when using the Best Fit option to automatically size report columns, select Improve
Display Performance.
By default, the Best Fit option examines content in every row and column in the report to calculate column
widths. Selecting Improve Display Performance changes the processing to examine only the content initially
displayed on the screen and in every 100th row in the report. Since not all content is examined, report load
times are reduced, though some items in the report might be truncated.
The Improve Display Performance option is ignored when using a report with cross tabs, rollups, conditional
formaing, and exceptions, since these require examining all content before the report is displayed.

8. To add a column to your report which displays actions you can take on records in the report, select Display
Links Column and select the commands you want to include in the column.
If the rows do not see unique records, such as a specic incident or contact, the Display Links Column check
box is disabled.

9. Click OK.

Customize a Report Background  
Adding colors or images to a report’s background can make it more suitable for presentations or other formal purposes.
You can add colors and images from the Background tab of the Display Options window.

1. From an open report, click the Page Setup tab.
2. Click the buon to the right of the Background group name.
3. Click the Background tab.
4. Enter eld information.

Field Description

Fill
 

This section lets you dene the colors to be used for the report’s background.
 

Color/Top Color/Left Color
 

The text description for this option varies depending on the Gradient Mode you select.
Click this box to select a primary color as the background. See Change Colors.
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Field Description

No Fill
 

Select this check box to clear any ll colors previously selected. If this box is selected,
 the other options on the Fill window are disabled except Color. Selecting a color
automatically clears the No Fill check box, enabling the other options.
 

Gradient Mode
 

Select the positioning of the primary and secondary colors for the background from the
Gradient Mode drop-down menu. Using gradient coloring lets you merge two colors.
The following options are available.
 

◦ None—Select this option to use only the primary color as the ll color. If you select
None, the Gradient Color eld is disabled.

◦ Top to Boom—Select this option to merge the colors from the top of the
background to the boom.

◦ Left to Right—Select this option to merge the colors from the left of the
background to the right.

Gradient Color/Boom Color/Right
Color
 

The text description for this option varies depending on the Gradient Mode you select.
Click this box to select a secondary color to merge with the primary color. The ll colors
then merge using the method dened in the Gradient Mode menu. See Change Colors.
 

Transparency(%)
 

Select a percentage to dene how intense the ll colors are. A seing of 100% is
completely transparent and prevents the ll colors from displaying. A seing of 0% has
no transparency, resulting in intense background colors. The selected percentage is
immediately reected in the Preview eld, so you can scroll through the transparency
percentages to nd a value that best suits your needs.
 

Preview
 

This area provides a sample of how the ll colors you select will appear on the report
background.
 

Picture
 

In addition to adding background colors for a report, you can add a background or
watermark image to the report.
 

Select Image
 

Click Select Image to select the image to use with the report. Images are added using
the Images explorer. See Images Explorer.
 

Clear Image
 

Click Clear Image to remove a previously selected image from the report.
 

Layout
 

Click this drop-down menu to dene the placement of the image on the background.
Available options are None, Title, Center, and Stretch.
 

5. Click OK.
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Add a Border to a Report  
You can also add borders to a report from the Display Options window. Each border can have dierent colors, styles, and
weights applied.

1. From an open report, click the Page Setup tab.
2. Click the buon to the right of the Display group name.
3. Click the Borders tab.
4. Enter eld information.

Field Description

Color
 

Click this box to select a color for the border. See Change Colors.
 

Style
 

Click this drop-down menu to select one of the following border styles: Solid, Dashed,
Doed, Inset, Outset, Double, Groove, Ridge, or Rounded.
 

Weight
 

Click this drop-down menu to select the width of the border in pixels. You can choose
between 1 and 10 pixels.
 

Preview
 

This area denes the placement of the borders you dene. Click any buon to place a
border or click the area in the Preview white space where you want the border.
 

Border buons
 

Click one of the border buons to add the selected border aributes to the top, boom,
 left, right, or all sides of the component. You can also add or remove borders from all
sides of the component.
 

5. Click OK.

Show or Hide Report Sections  
Dierent sections in a report can display large amounts of information you may not need to see. You can select which
sections you view in a report, making it easier to see only the information you want to view.

Report sections include docked lters, headers, footers, charts, data exceptions, and the data area, that shows the
tabular data returned by the report. You can hide or display each of these.

1. From an open report, click the Display tab.
2. To remove a section from the report, clear its check box in the Sections tab group. The available check boxes

are Docked Filters, Charts, Exceptions, Report Header, and Report Footer.
3. To add a section to the report, select the check box next to the section name.

Note:  If a section is disabled, it cannot be added to the report since it was not included when the
report was created.

4. To remove the data section from the report, click Data and select Do Not Display Data.
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Show or Hide Data Exceptions  
When you run a report that includes multiple data exceptions, you may not want to always display every exception in
the report. You can hide any exception included in a report or show hidden exceptions from the Exception Visibility
window.

1. From an open report, click the Display tab.
2. Click Exceptions.
3. To hide an exception, clear the check box next to the exception.
4. To display a hidden exception, select the check box next to the exception.
5. Click OK to apply the exception visibility to the report.

Change Report Magnication  
When viewing a report, you can change the magnication level to beer view the content.

The magnication slider always displays on the boom right of the content pane, but is enabled only when viewing a
report. The current magnication level is shown to the left of the slider. You can select levels ranging from 10 to 200
percent.

To use the slider, drag it to the left or right to decrease or increase magnication. You can also click the plus or minus
sign on either end of the slider.

Hide or Show Columns Using the Field Chooser  
If you don’t want to view all the elds included in a report when you view it, you can hide the elds temporarily. You can
also display elds in the report that are hidden.

1. From an open report, click the Display tab.
2. Click Field Chooser to open the Field Chooser window.
3. To hide a column in a report, drag the eld from the Show Fields in This Order section to the Available Fields

section, or select the eld to hide and click the left arrow.
4. To display a column that is currently hidden, drag the eld from the Available Fields section to the Show Fields

in This Order section, or select the eld to display and click the right arrow.
5. Click OK.

Hide or Show a Column Using Right-Click Options  
You can use the right-click menu options to hide or show a column in your report.

1. To hide a column, right-click the column you want to hide and select Hide Column.
2. To show a hidden column, right-click a visible column, select Insert Hidden Column, and select the column you

want shown in the report.
The column displays in the report in the column’s last location.

How You Change Report Sort Order  
A report’s default sort options are determined by the report’s parameters and output.

After generating a report, you can change your sort options to sort by any column in the report. You can sort columns
from the report’s Data tab or, if your report is shown using the report view, by clicking column headers.

Related Topics
• Run a Standard Report (video)
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Change Sort Order Using the Ribbon  
You can change the order of sorting information in a report.

1. From an open report, click the Home tab.
2. Click Sort. The Sort window opens.

The Sort buon is also available from the Design tab when using the layout view.
3. Select the primary eld you want to sort by from the Sort Items By drop-down menu.
4. To sort by the selected eld in ascending order, select Ascending. To sort in descending order, select

Descending. For example, to sort a report’s output by date created, with the newest dates at the top of the list,
you would sort the output in descending order.

5. To sort menu elds by the sequence of the eld’s entries, select Sort by Menu Sequence.
This option is available only when editing a custom report.
By default, when sorting information in a report using a menu eld, the information is sorted by the menu
eld’s entries in alphabetic order. For example, sorting a report by the Incidents Severity eld with entries of
Severe, Mid-Range, and Unimportant in ascending order lists records with Mid-Range, then Severe, and then
Unimportant severities.

However, when editing a custom report and dening the report’s default sort order, you can select the Sort by
Menu Sequence check box to sort by the order or the menu eld’s entries. Therefore, sorting the Severity eld
by sequence in ascending order would result in records with Severe, then Mid-Range, and then Unimportant
severities. In this example, this sort order would likely be more helpful for those using the report.

6. To sort on additional elds, select the elds to sort on from the Then By drop-down menus.
When you dene multiple sort elds, the records are initially sorted by the rst sort eld. If any of the records
have the same value for the rst sort eld, those records are then sorted by the subsequent sort elds.

7. To remove all sort options, click Clear All.
8. Click OK.

The report refreshes using the sort order you dened.

Change Sort Order Using Column Headers  
You can quickly change the sort order using column headers.

1. Click Views on the Display tab and verify that your report is shown using the report view.
2. Click the header of the column you want to sort by.

The report is sorted by the column you select in ascending order, and an arrow displays on the column’s header.
3. To change the direction of the sort, click the column’s header again.
4. To add additional levels of sorting to the report, press Shift and click the headers of the columns in the order in

which they should be added to the sort.
The report is sorted by the selected columns in ascending order, and arrows display on the sort columns’
headers.

5. To change a column’s sort direction when sorting by multiple columns, press Shift and click the column’s
header.

Enable Auto Filters  
You can add auto-ltering to report columns, giving you a quick way to lter data on any eld included in the report.

When this feature is enabled, a down arrow appears in the specied column headings of a generated report. By clicking
the down arrow, you can lter the report by a value in that column. For example, in a column that displays incidents’
associated products, you could click the down arrow to select a certain product. Only incidents associated with that
product would display in the report.
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Auto ltering hides ltered records but does not remove them from the report output. For this reason, total record
counts displayed on the report will not change when auto ltering is used.

1. From an open report, click the Home tab.
2. Click Auto Filter to display arrows next to each column in the report. Click the Auto Filter buon again to turn

o auto ltering.
3. To lter on a column, click the down arrow located in the column’s header to open the drop-down menu for the

column.

Note:  When data is ltered by a value in a particular column, the down arrow in that column’s header
changes from blue to red to show that ltering is active.

4. To show only those records that have a specic value for the column, select the value to lter on. Any records
that do not have this value are removed from the report output.

5. To remove any ltering on values in the selected column, select All.
6. To show only those records with values at the top or boom ranges of the selected eld’s values, select Top 10.

When you select this option, the Top 10 window opens.
a. Select Top or Boom from the Show drop-down menu to dene whether the records with the highest or

lowest eld values are displayed.
The denition of what a high or low value in a eld is depends on the type of eld. For example, in date
elds, the oldest dates are at the top and the newer dates are at the boom, whereas values in text elds
are in descending alphabetical order.

b. Select the number of records or the percentage of the total number of records returned in the report to
include in the ltered data.

c. Select whether the ltered data should include a specic number of items or a percentage of the total
number of records.

d. Click OK.
7. To create a custom lter on the eld, perform the following steps:

a. Select Custom.
The Custom Auto Filter window opens. Only records that match your custom lter display in the report.

b. Dene the custom lter you want to use.
The lter options vary somewhat depending on the type of eld that is being ltered on. For example,
date elds include calendar options, whereas text elds do not. However, every window has a drop-
down menu from which you can select the operator, and an area to enter the lter value. See Overview of
Report Filters.

Note:  To specify values from menu elds, the value must be entered manually. When using
the In List or Not In List operators, the values must be comma-separated. Text values must
be enclosed in single quotation marks. For example, to enter multiple names from the
Incidents.Assigned eld (incidents.assgn_acct_id), enter them as ‘Bob Jones’,‘Sarah Smith’,‘Tom
Payne’.

c. Click OK.

Add Page Breaks  
You can add page breaks to your reports to make them easier to use.

If page breaks are added to a report, only the specied number of rows display. A report with page breaks includes
controls to navigate to other pages.

Note:  When page breaks are added to a report, the slicing, cross tab, and rollups options are disabled. In
addition, page breaks are disabled in published reports.
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Page breaks can be added from the Search window or from the Display tab when viewing a report. The following
procedure describes adding page breaks from the Display tab. See How You Search in Reports for information about
using the Search window.

1. From an open report, click the Display tab.
2. Click Page Report and select the number of rows per page you want for your report.
3. To specify a dierent number of rows per page, click Page Report and select More Options.

a. Select Page Report. If the report is already paged, this check box is automatically selected when you
open the window.

b. Enter the number of rows you want on each page in the Rows per Page eld.
c. Click OK.

4. To remove paging from the report, click Page Report and select Remove Paging.

After you select the number of rows you want, the report displays with a list of page numbers and arrows at the
top of the page. Clicking |< or >| takes you to the rst or last page of the report. Clicking < or > takes you to the
preceding page or the next page of the report. If enough pages are present in the report, you will also see <<
and >> at the top of the report. Clicking these arrows displays the preceding or next set of page numbers in the
report controls.

How You Slice Report Data  
Slicing a report allows you to group tabular data sharing common values in elds included in the report.

Slicing a report allows you to group tabular data sharing common values in elds included in the report. You can then
select from the slice tree or links and view only the report data that matches the selected eld values. For example, in an
incidents report, you could slice by the assigned sta member to display incidents assigned to that person. You could
then further break down the incidents assigned to the sta member by other elds such as status.

Note:  When slicing and cross tabs are applied to a report at the same time, the cross tab is applied rst,
followed by slicing.

An example of an incidents report sliced in this manner is shown in the following gure. The slice options are displayed
in a tree format.

The next gure shows a report sliced on assigned account with the slice options displayed as links.
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Tip:  You can hide the slice section in your report by clicking the section’s Auto-Hide buon or you can remove
slicing from the report by clicking the Close buon on the slice section’s header.

Slice Report Data  
You can congure a report you’re viewing to display the report’s data in slice groups.

1. From an open report, click the Home tab.
2. Click Slice. The Slice window opens.

Tip:  When viewing a report using the layout view, you can select a column, click the Design tab, and
click Slice to slice the report by the selected column.

3. Enter eld information.

Field Description

Slice By
 

Select from the following options to dene the slice by column values or buckets.
 

Column Values
 

Select this option to dene slicing by specic values in the elds included in the report.
For example, if slicing on the incidents’ Status Type eld, you can slice on Unresolved,
 Waiting, or Solved.
 

Buckets
 

Select this option to dene slicing by groupings of values in the elds included in the
report, such as Solved and Waiting incidents. When you select this option, the window
changes to let you dene the groupings. See Dene a Slice Bucket.
 

Display Slices
 

Select from the following options to dene how the slice groups selection appears in the
report.
 

As a Tree
 

Select this option to display slice groups in a tree that is docked to the report.
 

Show Group Counts
 

Select this check box when displaying slices as a tree to include the number of records in
the slice group. The number displays next to each group name in the tree.
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Field Description

 

As Links
 

Select this option to display the slice groups as links above the data. This option is
available only when a single report eld is included in the slice.
 

Slice Items By
 

Select the elds to slice items by. If more than one eld is selected, the rst eld denes
the top slice group, and the subsequent elds selected dene subgroups in the top
group. If there are multiple slice elds dened, and the rst is set to None, the other slice
elds are also cleared.
 

Ascending/Descending
 

Select these options to sort the entries in the slice tree or links in ascending or
descending order.
 

Sort by Menu Sequence
 

When slicing by a menu eld, such as incidents status, select this check box to order
the slice groups using the order of the options in the menu eld. If this check box is not
selected, the slice groups will be ordered alphabetically.
 
This option can be congured only when editing the report on the report designer. See
Open the Report Designer.
 

Drag and Drop Options
 

Click this text to congure custom drag-and-drop options for inline editing. See Use
Slicing to Edit Records.
 
This option can be congured only when editing the report on the report designer. See
Open the Report Designer.
 

Clear All
 

Click this buon to reset all slice elds to None.
 

4. Click OK.
The report displays with the slice groups you dened.

5. To remove slicing from your report, click  Slice > Reset .
6. To display the number of records in each slice group displayed as a tree, click  Slice > Display Group Counts .

The number of records in each slice group displays next to the group names in the slice tree.
7. To switch between displaying slice groups as a tree and as links, click  Slice > Display Slice Items > As a Tree

or As Links .

Note:  If you’re slicing by more than one column and change the display from a tree to links, only the
rst slice column displays.

Dene a Slice Bucket  
Slicing records by buckets lets you dene groupings of data to sort on that would not be allowed by slicing on specic
values in a eld.

For example, slicing incident reports on the date created values may not be eective since the unique values in date/
time elds cover a small span of time. Slicing on such a eld would result in very granular slices. However, dening a
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slice bucket on the date created eld would allow you to slice the report output by incidents created during a date range,
such as the past seven days.

1. From an open report, click the Home tab.
2. Click Slice.

The Slice window opens.
3. Select Buckets in the Slice By section.

The options on the Slice window change to let you create, edit, or delete buckets.
4. Select the eld on which to slice from the Slice Column drop-down menu.
5. Click Add Bucket.

The Slice Bucket window opens.
6. Enter eld information.

Field Description

Name*
 

Enter a name for the new bucket.
 

Operator
 

Click this drop-down menu to select the operator to use. Operator options are the same
as those available when dening lter values, described in Overview of Report Filters.
 

Value
 

Select the values from this eld to add to the bucket. The available values change
depending on the eld selected. For example, some elds display drop-down menus
with various values to select, while other elds display a calendar to select specic dates
or date ranges.
 
To specify values from menu elds, you must manually enter the value. When using
the In List or Not In List operators, the values must be comma-separated. Text values
must be enclosed in single quotation marks. For example, to enter multiple names from
the Incidents.Assigned eld (incidents.assgn_acct_id), enter them as ‘Bob Jones’,‘Sarah
Smith’,‘Tom Payne’.
 

7. Click OK to return to the main Slice window.

Dene a Cross Tab Report  
Cross tabs let you display report output in a table to summarize large amounts of data.

Using a cross tab table, you can select the elds to dene the table’s rows, columns, and output elds, essentially
grouping the data by both the row and column output. The output elds are a culmination of the row and column
data. For example, if you had a report that returned the number of incidents assigned to each agent and the incidents’
statuses, you could designate the assigned account column as a row eld, status as a column eld, and number of
incidents as a data eld. The output would be similar to the sample report displayed in the following gure, which shows
the number of incidents categorized by assigned sta member and status.
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After you view your report data using the columns, rows, and output elds you dene, you can select dierent elds to
use as the columns, rows, and output elds. This lets you restructure the report to view groupings of dierent data, such
as the number of incidents each sta member has, grouped by category instead of product. Without using cross tabs,
the only way to retrieve these dierent summaries of data would be to use separate reports.

Note:  When cross tabs and slicing are applied to a report at the same time, the cross tab is applied rst,
followed by slicing.

1. From an open report, click the Display tab.
2. Click Cross Tab.
3. Select Choose Columns. The Cross Tab window opens.
4. Enter eld information.

Field Description

Available Columns
 

This section lists the output elds included in the report available for cross tabs. Fields
from this section can be dragged to the row, column, and output elds, or a eld can be
moved by selecting it and clicking the right arrow.
 

Row Fields
 

Move elds to this section to dene them as rows in the report.
 

Column Fields
 

Move elds to this section to dene them as columns in the report.
 

Output Fields
 

Move elds to this section to dene them as output elds in the report.
 

Display Output Fields
 

The options in this section let you dene where the headers for the output elds should
be in relation to the column elds.
 

Above Column Fields
 

Below Column Fields
 

Select these options to place the output eld above or below the columns’ values.
 

Perform Cross Tab Calculations
 

Select this check box to perform cross tab calculations. An additional column displays
for each cross tab calculation.
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Field Description

 

Clear All
 

Click this buon to clear all elds and reset the cross tab denition.
 

5. Click OK.
6. To remove cross tabs from your report, click  Cross Tab > Reset .
7. To perform cross tab calculations on the report, click  Cross Tab > Perform Cross Tab Calculations .
8. To switch between displaying output elds above or below column elds, click  Cross Tab > Display Output

Fields > On Top or On Boom .

Dene Rollups  
You can dene rollup levels in a report to group data beneath headings in the report. You can add additional rollup
levels to further break down the data under each heading by grouping data under subheadings.

Using rollups, you can group rows in a report that share the same value in the columns you select for the rollup levels.
For example, you can use rollups in an incident report to group incidents by their status. You can then add a second
rollup level to group incidents with the same status by their assigned sta account.

1. From an open report, click the Home tab.
2. Click Rollups.

Tip:  When editing a report on the report designer, you can select a column and click Rollup on the
Design tab to roll up the report by the selected column.

3. Select Choose Columns.
The Rollups window opens.

4. Enter eld information.

Field Description

Rollup Items By
 

Select output columns from the drop-down menus in this section to use as the primary
rollup level. After you select a column, you can select the sort order for the rollup
column. Options include Do Not Sort, Sort Ascending, and Sort Descending.
 
You can add additional columns to the primary rollup level in this section by selecting
the columns from the other drop-down menus. When multiple columns are used in a
rollup level, the data displayed in the same rollup heading has the same values in all the
columns selected for the rollup level.
 

Show Field in View
 

Select this check box to display the rollup column you selected as a column in the
report. If this check box is not selected, the column name displays in the rollup heading,
 but is not included as a column in the report output.
 

Then By
 

Select output columns from the drop-down menus in this section to use as the
secondary rollup level. After you select a column, you can select the sort order for the
rollup column. Options include Do Not Sort, Sort Ascending, and Sort Descending.
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Field Description

Secondary rollup levels break down the data in the primary rollup level according to the
columns selected for the secondary level.
 
After you dene a secondary rollup level, an additional Then By eld displays, allowing
you to dene a third rollup level to further break down the data grouped in the
secondary rollup level.
 
If records grouped in the secondary rollup have null values for the rolled-up eld and
if the rolled-up column is formaed to display blanks for records with null values, the
header for the secondary rollup level does not display.
 

Display Rollup Headings
 

Select this check box to display the rollup headings and subheadings. If this check box is
not selected, the headings do not display, though the report data is still sorted as if the
headings were present.
 

Display Rollup Headings Multi-Line
 

Select this check box to display each rollup column as a separate heading. If this check
box is not selected when using multiple columns in the same rollup level, the columns
for the rollup level display in the same heading.
 
This check box is disabled if the Display Rollup Headers option is not selected.
 

Note:  This option is not currently supported on the Agent Browser User
Interface.

Display Rollup Column Headings
 

Clear this check box to hide the name of the rolled-up column on rollup group headings.
By default, the name of the column you roll up is displayed for each rollup group.
 

Repeat Column Headings for Each
Rollup
 

Select this check box to show the output column headers before each rollup heading
and subheading. If this option is not selected, the column headers display only at the
top of the report.
 

Note:  This option is not currently supported on the Agent Browser User
Interface.

Display Group Counts
 

Select this check box to display the number of items in each rollup heading and
subheading.
 

Collapse All Rollups when Report is
Loaded
 

Select this check box to collapse all rollups in the report when it initially loads.
 

5. To remove the rollups you have selected on the Rollups window, click Clear All.
6. Click OK to generate the report using the rollups seings.
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The report refreshes, displaying the rollup levels you dened.
7. To quickly remove rollups from your report, click the arrow on the Rollups buon and select Reset.
8. To display the number of records in each rollup group, click the arrow on the Rollups buon and select Display

Group Counts. Repeat this to hide the headings.
9. To display headings for each rollup group, click the arrow on the Rollups buon and select Display Rollup

Headings. Repeat this to hide the headings.
10. To show the name of the rolled-up column in the heading for each rollup group, click the arrow on the Rollups

buon and select Display Column Headings. Repeat this to hide the column name.
11. To display repeating column headers, click the arrow on the Rollups buon and select Repeat Column

Headings. Repeat this to hide repeating column headings.
12. To collapse all the rollup headings in a report, click the arrow on the Rollups buon and select Collapse All.

When viewing a report with rollup headings, you can click the minus or plus buon next to each heading to
collapse or expand the headings to hide or display the rows beneath the headings.

Related Topics
• Create a Custom Report (video)

Display Guided Assistance Information in Tree Format  
Guided assistance allows you to oer help to your customers using questions that then branch to other questions or
answers.

Displaying the guided assistance questions and responses in a way that clearly shows the relationships between them
can be challenging using the standard formats available for reports. However, you can congure reports that output this
information to display the report columns in a tree format to clearly show the branching relationships in the data. See
Overview of Guided Assistance.

Note:  This option is available only when the report displays information from the Guided Assistance
Responses (decision_tree_responses) table. This option is disabled when the report is congured to display
data using cross tabs. See Dene a Cross Tab Report.

The following report is congured to display guided assistance data in a tree format.

1. Open the report that contains the guided assistance information.
2. Click the Display tab and then click Guide.

The Edit Guide Display Options window opens.
3. Enter eld information.
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Field Description

Available Columns
 

This section lists the output elds included in the report. Fields from this section can be
dragged to the row elds, question elds, and response elds sections, or a eld can be
moved by selecting it and clicking the right arrow.
 

Row Fields
 

Move elds to this section to dene them as rows in the report. Row elds generally do
not have a parent/child relationship with other data in the report, but instead show data
that applies to the entire guide tree. For example, a row eld could display the name of
the guided assistance guide that includes the question and response elds.
 

Question Fields
 

Move elds to this section to dene them as question elds in the report. These
elds generally display information pertaining to the questions, such as the question
description or question type.
 

Response Fields
 

Move elds to this section to dene them as response elds in the report. These
elds generally display information pertaining to the responses, such as the response
description or response order.
 

Parent Question Field
 

Click this drop-down menu and select the eld you want to use to display the parent
question in the tree. Only integer or text type elds can be selected.
 

Child Question Field
 

Click this drop-down menu and select the eld you want to use to display the parent
question’s child questions. Only integer or text type elds can be selected. In addition,
the eld type must match that of the eld selected for the parent question eld.
 

Clear All
 

Click this buon to clear all elds and reset the guide display options.
 

4. Click OK.

How You Save Report Display Seings  
You can choose to save or clear any changes to the report display seings.

After you edit a column or make changes to a report’s output options, you can use the Save as Default and Restore
options on the Home tab’s Default Seings buon to preserve the changes or to clear any changes you made.

Save Display and Data Seings for a Report  
Using the Save as Default feature, you can save changes to a report’s display and data seings to your workstation so
the report uses the same seings you have previously dened.

When you change display and data seings or column formaing to modify a report’s appearance, those changes are
lost when you close the report. However, you can save your preferences for these seings as your default so they are
used automatically when you next open the report.
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If you save default seings for a report and the report’s default seings are later changed, your saved seings are
removed. Saved seings are user specic, so you must log in as the same sta account to have your saved seings
applied to the report. See Change Your Personal Seings.

1. Open a report and change display and data seings.
2. Click the Home tab.
3. Click  Default Seings > Save as Default .

Reset Display and Data Seings  
You can remove a report’s display and data seings that are stored on your workstation. This restores these seings to
the defaults dened in the report.

1. Open a report that has display and data seings stored on your workstation.
2. Click the Home tab.
3. Click  Default Seings > Restore .

A warning message asks if you’re certain you want to restore the default seings.
4. Click Yes to delete your personalized report seings from your workstation.

How You Edit Data on a Report  
When a report displays unique records, such as incidents or opportunities, the Inline Editing feature lets you edit the
values in columns shown on the report without opening the records.

Individual values can be edited directly from the report, or you can edit values in multiple records. For example, if a
report shows the sta member an incident is assigned to, you can change the assigned sta member from the report
without opening the record, or you can reassign several incidents shown on the report to a selected sta member.

Note:  In order for sta members to edit records using inline editing, their prole must include permission to
edit the type of records returned in the report. See Analytics Permissions. In addition, inline editing must be
enabled for the report and the report must display data that can be edited. See Enable Inline Editing.

When you edit data inline on a report, the changes you make need to be saved to the server. If this is not done, the
information stored in the server’s database will not be updated. You can either manually save the changes or use the
Auto Save feature to automatically save each change after it is made.

Edit an Individual Value Inline  
When editing options are enabled in a report, the data shown for a record on the report can be edited directly without
opening the record.

Editing options vary depending on the type of eld being edited. For example, a text eld presents a text box and a
menu eld presents a drop-down menu.

1. Click the row that displays the information you want to edit.

Tip:  You can see which elds can be edited inline by hovering over the elds on the selected row.
Fields that can be edited are highlighted in blue.

2. Click the eld that you want to change. Editing options specic to the eld’s data type display. For example,
menu options display for menu elds and date options display for date elds.

3. Enter the new value.
4. Press Enter or click outside the eld you’re editing. Changes to some eld types are applied automatically when

you enter the value.
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Tip:  You can press Esc to cancel the edit.

5. If inline edits are not saved to the server automatically, click Save to save the change to the server. See Save
Edits Performed Inline.

Use Slicing to Edit Records  
One of the methods you can use to edit elds enabled for inline editing is to drag a record from a report to a slice node
that is dened by the same eld. By default, you cannot edit any elds using drag-and-drop that are not used in the
slice tree.

As an example, if a report is sliced by incident status, you can drag an unsolved incident to a slice node grouping solved
incidents to change the incident’s status to Solved.

Note:  You can’t customize slice drag-and-drop options when running a report. The options must be
congured when editing the report on the report designer.

By customizing slice drag-and-drop options, you change the drag-and-drop behavior to edit elds in a record that are
not used in the slice tree. For example, you can associate several tasks with an incident by dragging the tasks from the
report output to the slice node that includes the incident you want them associated with.

This feature is also useful when working with custom objects and aributes with record associations. For instance, if you
use a custom aribute in incident workspaces to create associations with parent incidents, you can drag incidents listed
on a report and drop them on a slice node that contains the parent incident you want them associated with.

1. Open the report you want to edit on the report designer.
2. Click Inline Editing on the Home tab to ensure inline editing is enabled.
3. Click Slice.

The Slice window opens.
4. Click the Slice Items By drop-down menu and select the column you want to use to slice the report output.

The column you choose to slice by is used to create groups of records. It does not necessarily store the values
that are changed when dropping values from other records. The column that stores the values that are changed
will be selected below.

5. Click Drag and Drop Options.
The Drag and Drop Options window opens.

6. Select Enable Drag and Drop.
This check box is selected by default; however, it is disabled if the slice column is enabled for inline editing.

Note:  If you select multiple columns to slice by on the Slice window, you can select the On Drop Apply
Edit to Only this Column in the Slice Tree check box to prevent values in the dragged records from
being changed automatically. This check box is cleared by default, which results in the records dragged
to the slice tree having their values changed to match that in the other slice columns. For example, if
you have a second slice on Status and drag an unresolved incident to a slice that groups incidents with
a Solved status, the incident you drag will have its status set to Solved. This check box has no impact if
only one column is used in the slice.

7. Click the Source Column drop-down menu and select the column with the values you want to use in the
destination column.

8. Click the Destination Column drop-down menu and select the column you want to populate using the values
from the source column.
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The options displayed in the drop-down menu depend on the selected source column since the columns must
have the same data type (such as text, currency, or integer).

9. Click OK.
10. Click OK to close the Slice window.
11. Click Save on the Quick Access toolbar.

When you run the report, you will drag records you want to change to the slice tree. Those records will have their record
associations changed to match that of the record included in the slice you drag them to.

Related Topics
• How You Edit Data on a Report

• Enable Inline Editing

How You Edit Values in Multiple Rows  
If your report includes numerous rows with the same value that you want to edit, you can select the rows and change
the value using the Edit Selection feature.

You can also use slicing to group the records by the eld you want to edit and then drag the records you want to change
to the correct slice group.

Edit Values in Multiple Rows Using the Ribbon  
Multiple records can be selected and edited using the ribbon.

1. From an open report that allows inline editing, press Ctrl while selecting each record.
2. Click the Home tab.
3. Click Edit Selection.

A menu displays the elds that can be edited in the rows.
4. Select the eld that you want to edit.

Editing options specic to the eld’s data type display.
5. Enter the value you want the selected records to have.
6. Click OK to apply the change to the selected records.
7. If inline edits are not saved to the server automatically, click Save on the Home tab to save the changes to the

server. See Save Edits Performed Inline.

Edit Multiple Values Using Slicing  
You can select and edit multiple records using slicing.

1. Slice the report to group the records by the eld you want to edit, displaying the slices as a tree rather than
links.

For example, if you want to reassign several incidents to a dierent sta account, slice the report by the report’s
Assigned Account column. See How You Slice Report Data.

2. Select the folder in the slice tree that contains the records you want to edit.
3. Press Ctrl while selecting each record you want to edit.
4. Drag the selected rows to the folder on the slice tree that shows the value you want. After you drop the rows on

the slice tree, the report is updated to show the new values for the selected rows.
5. If inline edits are not saved to the server automatically, click Save on the Home tab to save the changes to the

server. See Save Edits Performed Inline.
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Save Edits Performed Inline  
When you edit data inline, the changes need to be saved to the server.

If the Auto Save feature is enabled, each change is saved automatically. However, you can also disable Auto Save if you
want to make several changes and then save the changes to the server. See Enable Inline Editing for information about
enabling Auto Save.

When data has been edited on a report but the changes have not been saved to the server, a visual indicator displays on
the report next to the edited value. After the data is saved to the server, the visual indicator is removed.

1. To save changes automatically, click the Home tab and then click Auto Save. The buon is highlighted when
Auto Save is enabled.

Any other inline edits made to the report’s elds will be saved to the server automatically until the report is
closed again.

2. To save changes manually, click the Home tab and then click Save.

Dashboards  

Overview of Dashboards  
Dashboards are particularly useful for managers who need to view a wide range of data from dierent reports. Using
dashboards eliminates the need to open a large number of reports individually.

When viewing standard or custom reports, you generally open reports one at a time, and search for data in only the
report that is active. However, you can view and search for data in several reports simultaneously by adding them to a
dashboard. Each report in a dashboard retains the same functionality as if you opened the report separately, allowing
you to access and work with a variety of data from one dashboard.

How You Create Dashboards  
Dashboards are created and edited on the dashboard designer. You can modify your dashboards by adding images,
text, and controls, and changing their appearance.

If you don’t want to create a new dashboard, you can copy an existing custom or standard dashboard in the Reports
explorer and then edit the copy using the dashboard designer.

Note:  Customizations made to report displays in existing dashboards aren’t carried over when copying
dashboards. This can result in a copied dashboard displaying somewhat dierently than the original.

Open the Dashboard Designer  
The dashboard designer provides the tools you need to create and edit dashboards, and lets you access optional items
such as text elds and images to enhance your dashboards.
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The designer can be opened from the Reports explorer or by right-clicking a dashboard on the navigation pane and
selecting Edit Report Denition. The following procedure describes opening the designer from the Reports explorer.

1. If your navigation set is congured to add dashboards from the le menu, do one of the following:

◦ Click  File > Dashboard . See Overview of Navigation Sets.

◦ Click Analytics on the navigation pane and then double-click Reports Explorer.

2. To create a dashboard, click New Dashboard.
3. To edit an existing dashboard, right-click the dashboard and select Edit.

The dashboard designer opens. The designer consists of the ribbon, the design surface, where the dashboard
content is placed, and the reports explorer, which shows reports and other items you can place on the
dashboard. For descriptions of the ribbon and main components, see Overview of the Dashboard Designer
Ribbon and Overview of Dashboard Designer Components.

Overview of the Dashboard Designer Ribbon  
When you open the dashboard designer, the ribbon includes the Home, Display, and Page Setup tabs from which you
can access tools to edit the dashboard.

Each tab has one or more groups containing buons you can use to modify the dashboard or items on the dashboard.

Note:  To minimize the ribbon when editing a dashboard, double-click a tab. Click the tab to temporarily
display the buons and click the tab again to hide them. To permanently restore the tab buons, double-click
the tab again.

Dashboard Designer Home Tab  
The options available on the Home tab let you preview the dashboard you’re editing and congure options that apply
to the entire dashboard. For example, you can select a dashboard layout and specify when the dashboard’s contents
should be refreshed.

Group/Buon Description

Views
 

This buon lets you choose whether to view the dashboard using the report view or design view. See
How You Preview Dashboards.
 

Properties
 

The buons in this group let you modify properties that apply to the entire dashboard.
 

Options
 

Click this buon to select dierent options that impact how the dashboard runs. For example, you can
edit the dashboard description and specify when the dashboard’s contents should be refreshed. See
Edit Dashboard Options.
 

Scheduling
 

Click this buon to schedule the dashboard to be sent to other individuals. A dashboard can be
scheduled and sent just as a report can. However, since data exceptions cannot be applied to
dashboards, alerts cannot be added to the dashboard’s schedule. See How You Schedule Dashboards to
be Sent.
 
This buon appears only when scheduled reports are enabled. For information about enabling
scheduled reports, contact your Oracle account manager.
 

Permissions
 

Click this buon to dene which proles should have access to run and edit the dashboard. See Set
Dashboard Permissions.
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Group/Buon Description

Audit Log
 

Click this buon to open the audit log for the dashboard, which shows you when the dashboard was
created, edited, run, and published, and which sta members performed these actions. See View the
Dashboard Audit Log.
 
The Expanded Report Audit Log is also available. This shows you when reports and dashboards have
been generated, printed, exported, and previewed over the previous 30 days. See View the Expanded
Report Audit Log.
 

References
 

Click this buon to access predened reports that show you the workspaces, navigation sets, and
report links that use the dashboard you are editing. Viewing these items before editing a dashboard
ensures that you’re aware of other items that might be impacted by changes you make. If you decide
the impact would be too great, you can create a copy of the dashboard and edit the copy instead.
 
If you have the Analytics Administrator prole permission, you can access versions of these reports
that include search options using the Report Management component. See How to Monitor Report
Usage.
 

Display
 

The buons in this group let you modify how the dashboard is displayed. For example, you can apply a
style to all the reports on the dashboard to give them a similar appearance.
 

Screen
 

Click this buon to display all the dashboard’s reports on the screen when the dashboard is run. Each
report can have separate scroll bars to view the report contents.
 

Scrollable
 

Click this buon to display all the contents of each report on the dashboard. When this option is
selected, each report displays in its preferred size and the height and width of the items in each report
are xed. Separate reports do not have separate scroll bars, but vertical and horizontal scroll bars are
added to the dashboard if needed to display the entire dashboard.
 
If the entire size of the dashboard exceeds 32767 x 32767 pixels, the dashboard contents are clipped
when using scrolling.
 

Display Options
 

Click this buon to change the dashboard’s width, add report title bars, and select which report
sections you want to display. See Change Dashboard Display Options.
 

Auto Format
 

Click this buon to apply a style to all the reports in a dashboard. This overrides styles applied to the
individual reports. See Apply a Style to a Dashboard.
 

Layouts
 

Click this buon to load a predened dashboard layout. Layouts let you quickly select how many
reports are shown on the dashboard and their position. When you select a layout, the design surface
is automatically adjusted to conform to the layout you selected. See Overview of Dashboard Section
Layouts.
 

Parameter Values
 

Click this buon to open the Set Filter Values window where you can specify defaults for searching
reports in the dashboard. See How You Specify Dashboard Search Defaults.
 

Add Tab
 

Click this buon to add a tab to the dashboard. Tabs let you create multiple pages for the same
dashboard, and you can select the reports that display on each tab.
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Dashboard Designer Display Tab  
The options available on the dashboard Display tab let you add images and text elds, show the dashboard header and
footer, and hide portions of the designer so you can see only the components you need.

Group Description

Insert
 

The buons in this group let you add images and text elds to your dashboard. See How You Add
Images and Text Fields to Dashboards.
 

Sections
 

The check boxes and buon in this group let you show or hide the Dashboard Header and Dashboard
Footer sections, and choose how you want to display the dashboard’s description. See How You Add
Dashboard Descriptions.
 

Show/Hide
 

The buons in this group let you show or hide dierent parts of the dashboard designer. Showing the
reports explorer lets you select reports to add to the dashboard. You can also add rulers, rule lines,
 eld outlines, section headers, and a grid to the design surface to help you create your dashboard. See
Overview of Dashboard Designer Components.
 

Items
 

The buons in this group let you remove a selected report or a report placeholder from the dashboard,
 and let you show or hide the title of the selected report when the dashboard is generated.
 
The Remove buon is disabled when the only report on a dashboard is selected.
 

Dashboard Tab
 

The buons in this group let you add, delete, rename, and move dashboard tabs. See How You Add
Tabs to Dashboards.
 

Dashboard Designer Page Setup Tab  
The options on the Page Setup tab let you congure printing options for the dashboard. These options are applied only
when printing.

Group/Buon Description

Print
 

The buons in this group let you congure the dashboard for printing and add the Page Header and
Page Footer sections.
 

Print Margin
 

Click this buon to select the size of the margins used when printing the dashboard. The available
options are Normal, Narrow, Medium, and Wide.
 

Size
 

Click this buon to select the size of the paper used when printing the dashboard. The available
options are Leer, Legal, Executive, A3, A4, and A5.
 

Portrait/Landscape
 

Click these buons to print the dashboard in portrait or landscape mode.
 

Page Header/Page Footer
 

Select these check boxes to include a page header and page footer when printing the dashboard.
 

Print to Fit
 

Select this check box to scale the dashboard to your printer’s default page width and send the
dashboard to the printer.
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Group/Buon Description

 

Dashboard Designer Text Field Tab  
The ribbon’s Text Field tab is shown when you select a text eld on the dashboard designer.

You can use the buons on the tab to edit the text eld’s fonts, margins, and borders.

Group/Buon Description

Edit
 

Click this buon to open the Edit Text Field window, where you can select fonts, margins, ll colors,
 and borders for the text. Many of the buons on the Text Field tab let you customize the same options
available on the Edit Text Field window.
 

Arrange
 

The buons in this group let you position and size the selected text eld.
 

Anchor
 

Click this buon to dene an anchor style for the image or text eld. Anchor styles determine how an
image or text eld moves in relation to the borders of the dashboard section. See Specify an Anchor
Style for a Text Field and Specify an Anchor Style for an Image.
 

Bring to Front/Send to Back
 

Click these buons to place the selected item on top of or beneath other overlapping items.
 

Size to Fit
 

Click this buon to automatically shrink or expand the element containing the image or text eld to t
the selected item.
 
Manually resizing the selected element disables Size to Fit.
 

Font
 

The buons in this group let you change the font style, size, and color. You can also select font
aributes, such as bold and italic, and change the text’s alignment within the text eld. In addition, you
can add a background color for the text eld.
 

Margin
 

Click this buon to select the width of the margins around the item. The available options are None,
 Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels for the
top, boom, left, and right margins.
 

Border
 

The buons in this group let you add borders to the text eld and change the borders’ display options.
You can identify which borders you want and choose the borders’ color, size, and style.
 

Dashboard Designer Options Tab  
The ribbon’s Options tab is shown when you select an item on the dashboard design center.

The buons on the tab vary depending on the item you select and let you customize the item. For example, if you select
a report on the dashboard, you can use the buons on the Options tab to add a border around the report and choose
background colors.
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Group/Buon Description

Margin
 

Click this buon to select the width of the margins around the item. The available options are None,
 Narrow, Medium, Wide, and Custom. Selecting Custom lets you specify the number of pixels for the
top, boom, left, and right margins.
 

Border
 

The buons in this group let you add borders to the text eld and change the borders’ display options.
You can identify which borders you want and choose the borders’ color, size, and style.
 

Fill
 

The buons in this group let you add a background color to the selected item. You can select the
background color and add a gradient color to blend into the primary color. You can also choose how
intense the colors should be with the Transparency seing.
 

Layout
 

The buons in this group let you dene how the content of the selected dashboard section should
be arranged and how the height of the dashboard section should be managed. See Overview of
Dashboard Section Layouts.
 

Add Text Field
 

Click this buon to add a new text eld to the dashboard.
 

Overview of Dashboard Designer Components  
The tasks you perform when creating or editing a dashboard are performed using the dashboard designer’s ribbon,
design surface, and reports explorer.

These components provide access to the reports, dashboard sections, and other items you use to create and edit
dashboards.

Dashboard Section Description

Page Header
 

This section accepts images and text elds and is displayed at the top of dashboards when you print
them.
 

Dashboard Header
 

Contains text elds and images that display at the top of the dashboard. By default, the header
contains text elds you can modify for the dashboard’s title and subtitle.
 

Dashboard Description
 

Contains text that you can modify to provide general information about the dashboard. You can display
dashboard descriptions inline to show the description on the dashboard or as text on a separate tab on
the dashboard. See How You Add Dashboard Descriptions.
 

Dashboard Items
 

Contains the reports and components you add to the dashboard.
 
If you add tabs to the dashboard, the name of this section changes to Tabs, and a tree is added from
which you can add content to each tab. See How You Add Tabs to Dashboards.
 

Dashboard Footer
 

This section contains text elds and images that display at the boom of the dashboard.
 

Page Footer
 

The page footer is similar to the page header section. The text elds and images added to this section
display at the boom of printed dashboards.
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Dashboard Design Surface  
The design surface displays the dashboard sections you want to include in the dashboard.

After a dashboard section is displayed on the design surface, you can add, edit, and remove content in the section. For
example, you can drag reports to the Dashboard Items section, insert text elds into the Dashboard Header, and change
the background of the Dashboard Footer.

You can add rulers, lines, and headings to help you identify sections and elds shown on the design surface. These
options are accessed from the Show/Hide group on the Display tab.

Option Description

Show Rulers Click this buon to display horizontal and vertical rulers when designing the dashboard to provide a
perspective on the size of the dashboard.
 

Show Rule Lines Click this buon to display horizontal lines separating the dashboard sections displayed on the design
surface.
 

Show Field Outlines Click this buon to display borders around the elds you add to the dashboard.
 

Show Section Headers Click this buon to display a heading above each dashboard section.
 

Show Grid Click this buon to display a grid in the dashboard’s header and footer sections to help you align items
you add to the sections. You can also click the arrow on the buon to select the grid size you want to
use.
 

Dashboard Reports Explorer  
The dashboard designer’s reports explorer lists the items that can be added to a dashboard. You add these by dragging
them from the reports explorer to the dashboard’s design surface.

The reports explorer on the dashboard designer includes reports, notications, infolets, and a web browser component
that you can place on the dashboard. If your site is congured to use custom add-ins, they are also available in the
Components tree.

You can also hide the reports explorer to add more room to the design surface if you do not need to add reports. To hide
the reports explorer, click the Display tab and then click the Reports Explorer buon. You can click the buon again to
show the reports explorer.

Tip:  You can drag the reports explorer and reposition it on the dashboard designer or open it in a new window
just as you can move the data dictionary on the report designer. See Move the Data Dictionary.

Apply a Layout to a Dashboard  
The use of layouts is optional, but they oer a helpful starting point when creating dashboards.

When creating a dashboard, you can use dashboard layouts to add predened regions to the design surface. You can
then drag reports and other content to the regions.

1. Click the Home tab.
2. Click Layouts to open the layouts menu.
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3. Select the layout you want to apply to the dashboard.
The design surface is updated to reect the layout you selected.

4. To modify the spacing of the dashboard layout you selected, hover over the spaces between the report areas
until the cursor changes to show direction arrows. You can then drag the borders to the position you want.

Consolidated Dashboard Layout  
Unlike the other dashboard layouts that determine where individual reports display on the dashboard, the Consolidated
Dashboard layout groups information from all reports on the dashboard into a single report.

Using this layout lets you display data from multiple, unrelated tables in a single report. While you can create reports
that pull information from unrelated tables, they may fail to run due to database query limits.

Since consolidated dashboards combine data by matching the columns in the reports you add, all the reports must
have the same number of columns and the corresponding columns in each report must have the same data type. For
example, if one report has ve columns, the other reports you add to the dashboard must also have ve columns, all
matching the data types of rst report’s columns.

How You Place Content on Dashboards  
You can add reports and other items to a dashboard by dragging them from the dashboard designer’s reports explorer
to the design surface.

You can decide where to place each item and how much content you want on the dashboard. You can also add tabs to
the dashboard to place additional reports and other content that may not t on the dashboard’s main page.

There are ve types of items you can add to dashboards from the dashboard designer’s reports explorer.

Note:  Each dashboard can have a maximum of fty items placed on it.

• Reports—Most items you add to dashboards will likely be reports, though there are considerations to keep in
mind before you add them. Private reports on a dashboard can be viewed by sta members with permission
to open the dashboard, even if the sta members do not have permission to view the individual reports. This
may result in sta members seeing information they should not have access to. If a report used on a dashboard
is deleted, the report is automatically removed from the dashboard and a placeholder for the report displays
when the dashboard is viewed or edited. If you want to use the same report on a dashboard more than once
with dierent default lter values to show dierent data, you need to create a copy of the report and add the
copy along with the original report since only one set of lter values can be stored for each unique report on a
dashboard.

• Add-ins—If you have installed add-ins that are designed to be accessible in dashboards, you can access them
in the Components > Add-ins folder. You can drag add-ins to the dashboard just as you would drag a report.
See Overview of Add-Ins.

• Notications—You can drag the Notications component, located in the Components > Common folder, to the
dashboard to let sta members receive notices on the dashboard when particular events happen, such as an
incident being assigned. See Notications.

• Infolets—Infolets provide brief overviews of data pertaining to service performance, such as incident
assignments and incident backlog. Infolets are intended for use by managers who need quick overviews of
data without a great deal of detail. To add an infolet to a dashboard, drag the infolet you want from the Public
Reports > Service > Infolets report folder to the dashboard.
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Note:  The Agent Overview and Service Overview dashboards in the Infolets report folder provide a
look at agent performance and the status of your contact center. Reviewing these dashboards will help
you gain an understanding of infolets and how you might use them in your custom dashboards. When
creating custom infolet dashboards, we recommend using the Infolet auto format style.

• Web browser—A web browser can be added to a dashboard as well, allowing sta members to navigate to a
web page displayed in the dashboard. To add the browser to a dashboard, drag the Web Browser–Component
report from the Public Reports > Common report folder to the dashboard. After the browser is added to the
dashboard, you can specify a default URL in the dashboard’s parameters. See How You Specify Dashboard
Search Defaults.

How You Place Reports on Dashboards  
You can place reports on dashboards using drag and drop from the reports explorer. You can remove reports at any
time, and also replace existing reports with others.

If you need to make a change to a report on the dashboard, you can also open the report for editing directly from the
dashboard.

Note:  If your dashboard has only one report, you cannot remove it, but you can replace it with another report.

Add a Report to a Dashboard  
You can quickly add reports to a dashboard.

This procedure describes adding reports to the dashboard, but the same process is used to add any of the other items
listed in the dashboard’s reports explorer.

1. In the dashboard designer’s reports explorer, navigate to the report you want to add to the dashboard.
You can quickly locate reports by right-clicking a report folder in the reports explorer and selecting Search.

2. Select the report and drag it to the dashboard.
3. Drop the report on the design surface where you want the report to display.

When you drag the report to the design surface, positioning images, shown here, appear. Hovering over
the various images highlights portions of the design surface. After the section where you want the report is
highlighted, drop the report. The design surface refreshes to show the updated dashboard layout.

Icon Description

Entire Area
 

This icon group appears over the predened dashboard section you’re hovering
over when dragging a report. Hovering over the various icons in the group highlights
dierent portions of the dashboard section where you can drop the report.
 
You can hover over the center of the icon group to drop the report in the full dashboard
section. You can also place the report in the top, boom, left, or right portions of the
dashboard section by hovering over the individual icons in the group.
 
If you break up a predened dashboard section when dropping your report onto the
dashboard section, the dashboard’s layout is split into smaller areas.
 

Drop a report over one of these icons to place the report in the top, right, boom, or left
areas of the dashboard.
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Icon Description

    
 
Area Buons
 

 

4. To modify the size of the area where you placed the report, hover over the area’s borders until the cursor
changes to show direction arrows. You can then drag the borders to the position you want.

5. Repeat these steps to add additional reports to the dashboard.
6. Click Save on the Quick Access toolbar.

Remove a Report from a Dashboard  
You may want to remove reports from a dashboard.

Right-click the report on the design surface and select Remove.

Or

Click the item on the dashboard, click the Display tab, and click Remove.

Replace a Report on the Dashboard  
You can replace a report with another report from the reports explorer.

Drag the new report you want on the dashboard from the reports explorer and place it on top of an existing report on
the dashboard. The existing report is replaced with the new report.

Open a Report for Editing from the Dashboard  
Right-click the report on the design surface and select Edit Report Denition. The report opens on the report designer
where you can edit it.

See Open the Report Designer for information about editing reports.

How You Add Tabs to Dashboards  
Multiple pages containing reports can be added as tabs to the same dashboard.

When creating a dashboard, you may nd that you want more reports than can easily be viewed or that you want to
group similar reports together. By adding tabs to the dashboard, you can create multiple pages for the same dashboard,
and you can select the reports that display on each tab. Each tab acts as a distinct page of the dashboard. Reports are
added to the pages just as they would be if the dashboard had only one page.

Tip:  Each dashboard can have a maximum of fty tabs.

Add a Tab to a Dashboard  
You can add additional tabs to the dashboard.

1. Click the Home tab.
2. Click Add Tab.

After you add a tab, the dashboard designer is updated to show the tabs on the design surface. The tab names will likely
not be what you want, but you can change them.
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Change the Name of a Tab  
Tab names can be modied if needed.

1. Do one of the following:

◦ Right-click the tab on the design surface and select Rename.

◦ Click the tab, click the Display tab, and click the Rename buon.

2. Enter the new name for the tab.
3. Click OK.

How You Add Dashboard Descriptions  
Dashboard descriptions display information about the dashboard.

If you create a dashboard that will be used by other people, you can add a description to explain the purpose of the
dashboard or to relay other information concerning the dashboard. The description text can display inline on the
dashboard or as text accessed from a separate tab.

Add a Dashboard Description  
You can use the Edit Dashboard Description option to change the dashboard description.

1. Click the Home tab on the dashboard designer’s ribbon.
2. Click Options and select Edit Dashboard Description.

The Edit Dashboard Description window opens.
3. Enter the text for the description.
4. Click OK.

Dene the Description Location  
You can directly display the dashboard description inline or display it on a separate tab.

1. Click the Display tab and then click Dashboard Description.
2. To display the dashboard description on the dashboard, select Display Dashboard Description Inline.
3. To display the dashboard description on a separate Description tab, select Display Dashboard Description on

Separate Tab.

How You Add Images and Text Fields to Dashboards  
You can add images and text elds to your dashboard’s header and footer sections to clarify the dashboard’s purpose or
to make it more presentable to your target audience.

When you place an image or text eld on the dashboard, you can either manually position the item or it can be
positioned automatically depending on the section’s layout properties. After you add an image or text eld to a
dashboard section, you can reposition it if needed, and you can edit any text elds you have added directly from the
dashboard.

Overview of Dashboard Section Layouts  
You can set the layout for dashboard sections to be manual or automatic.

If the section has an automatic layout, the text eld or image is positioned automatically, and the dashboard section’s
height is adjusted to best t the image or text eld. You can also set table layout options to change how the items in the
section are sized. By default, dashboard sections have manual layout enabled.

Enable Automatic Layout of a Dashboard Section  
You can use an automatic layout of a dashboard section.

1. Add the dashboard section you want to your dashboard.
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a. To add the dashboard header or footer sections, click the Display tab and select the Dashboard Header
or Dashboard Footer check box.

b. To add the page header or footer sections, click the Page Setup tab and select the Page Header or Page
Footer check box.

2. Click the dashboard section you want to modify on the design surface.
3. Click the Options tab and click Automatic.
4. To prevent the section’s height from being automatically adjusted to t the items you add to the section, click

Auto Height to disable the feature.

Tip:  When Auto Height is disabled, you can manually change the height of the dashboard section by
dragging the section’s horizontal borders up or down, just as you would if the section had a manual
layout.

If a dashboard section has an automatic layout, the images and text elds you add to it are arranged in an invisible table
structure with the items placed in rows and columns. You can adjust the sizing of the rows and columns to arrange the
images and text elds as you want them.

Change Table Layout Options  
You can specify the table layout options for a dashboard section.

1. Add images and text elds to the dashboard section.
2. Select the dashboard section you want to modify on the design surface.
3. If the section has a manual layout, click Automatic on the Options tab to change to an automatic layout.
4. Click Table Layout on the Options tab.
5. To give each column in the section’s table the same amount of width, select Size All Columns Equally.
6. To give each row in the section’s table the same amount of height, select Size All Rows Equally.
7. To size each column to best show the column’s contents, select Auto Size All Columns.
8. To size each row to best show the row’s contents, select Auto Size All Rows.
9. To manually congure the table’s layout, select More Options.

The Edit Table Layout Properties window opens.
10. Enter eld information.

Field Description

Show
 

Select the row column you want to congure and then click this drop-down menu to
select whether you’re conguring rows or columns.
 

Size Type
 

Specify how the size of the report section is determined in this section.
 

Absolute
 

Select this option to specify a certain size for the selected row or column in pixels.
 

Percentage
 

Select this option to specify a certain percentage of the total available space in the
section to allocate to the selected row or column.
 

Best Fit
 

Select this option to have the size of the selected row or column automatically adjusted
to best t the row’s or column’s contents.
 

11. Click OK.

932



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Add a Text Field to a Dashboard  
You can add predened text elds to your dashboard, or you can add custom text elds you create in the Text Fields
explorer. You can also add new text elds you create from the dashboard design center.

The dashboard’s page header, dashboard header, page footer, and dashboard footer sections all accept text elds. See
Create a Text Field for information about creating custom text elds. After you add a text eld to a dashboard, you can
modify its text, fonts, colors, and borders to tailor the text eld to the dashboard’s audience. These edits to the text eld
are specic to the dashboard and do not aect the original text eld. This lets you customize the same text elds for
dierent dashboards.

1. Add the dashboard section to the design surface that you want to add the text eld to.
a. To add the dashboard header or footer sections, click the Display tab and select the Dashboard Header

or Dashboard Footer check box.
b. To add the page header or footer sections, click the Page Setup tab and select the Page Header or Page

Footer check box.
2. If you want the text eld to be automatically positioned on the dashboard, click the dashboard section, click the

Options tab, and click Automatic. See Overview of Dashboard Section Layouts.
3. To add a precongured text eld to the dashboard, click the Display tab and then click Text. The Insert Text

Field window opens.

The window displays standard text elds and custom text elds that you have added in the Text Fields explorer.
The text elds’ default fonts, colors, and other aributes are reected in the display.

4. Click the text eld you want to add to the dashboard. The Insert Text Field window closes, and the cursor
displays the name of the text eld you're adding when you hover over dashboard sections that accept text
elds, such as the dashboard header.

5. Click the dashboard section on the design surface where you want to add the text eld. The text eld is added
to your dashboard.

6. To add a new text eld that is not in the Text Fields explorer, click the Options tab and click Add Text Field. The
text eld is added to the dashboard section with default text and text aributes which you can then edit. See
Edit a Text Field in a Report.

7. Click Save.

Edit a Text Field on a Dashboard  
After you add a text eld to your dashboard, you can edit it to change the fonts, colors, text, and other aributes. These
edits apply to the text in the dashboard, but the original text eld is not aected.

Note:  Certain standard text elds, such as Current Date, include values that are dynamically updated when
the report is run. While these elds can be edited, you cannot edit their dynamic value placeholders.

Right-click the text eld and select Edit Text Field.

Or

Click the text eld and then click Edit on the Text Field tab.

The Edit Text Field window opens. For the procedure to use the options available on this window, see Edit a Text Field in
a Report.

You can also edit the text eld using the buons in the Font, Margin, and Border groups on the Text Field tab. These
buons provide shortcuts to many of the same options available on the Edit Text Field window.
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Add an Image to a Dashboard  
You can insert images you have added to your dashboard’s page header, dashboard header, dashboard footer, and page
footer. Images can act as backgrounds or header images in these sections.

See Images Explorer for information about adding images you can use on reports and dashboards.
1. Add the dashboard section to the design surface that you want to add the image to.

a. To add the dashboard header or footer sections, click the Display tab and select the Dashboard Header
or Dashboard Footer check box.

b. To add the page header or footer sections, click the Page Setup tab and select the Page Header or Page
Footer check box.

2. If you want the image to be automatically positioned on the dashboard, click the dashboard section, click the
Options tab, and click Automatic. See Overview of Dashboard Section Layouts.

3. Click the Display tab.
4. Click Image to open the list of images added in the Images explorer.
5. Click the image you want to add.
6. Hover over the section where you want to add the image. The cursor displays the name of the image you

selected when it is over a section that can accept an image.
7. Click to place the image in the dashboard section you select.
8. Click Save.

How You Move Images and Text Fields in Dashboards  
After you add an image or text eld to a dashboard section, you can move the eld by dragging it to the appropriate
place in the section. This may require dragging other text elds in the dashboard section to prevent the elds from
overlapping.

If the dashboard section has a manual layout, you can move the item to any location in the section you want. If the
dashboard section has an automatic layout, you can still move the item, but blue lines display when you drag the item,
showing you where the item can be placed in relation to any other images or text elds in the section.

When you click an image or text eld that has been added to a dashboard section, handles appear on the eld’s borders.
To increase or decrease the size of the eld, click the appropriate handle and drag it to a new position. When dragging
a text eld, the font size remains unchanged, but the text eld’s area is altered. However, when dragging an image, the
image itself is resized.

How You Change Dashboard Properties  
You can change the dashboard properties if needed.

Many of the buons on the Home tab let you specify a number of options that impact how the dashboard can be
used. For example, you can select who owns the dashboard, specify dashboard permissions, and set the time zone the
dashboard uses when it is opened. You can also schedule the dashboard to be sent in an email, view an audit log to see
who has viewed or edited the dashboard, and modify how the dashboard’s reports are searched.

Edit Dashboard Options  
Dashboard options let you modify numerous aspects of the dashboard that change how the dashboard appears and
functions.

You can select the time zone that should be used for the reports in the dashboard, change the dashboard owner,
and modify seings that impact how the dashboard functions when it is opened for viewing. You can also congure
automatic refresh of the data shown in the dashboard’s reports, select data source options, add notes to the dashboard,
and change the image displayed for the dashboard in report lists. These and other options are described in the
following procedure and are also addressed in Searching dashboard reports.

1. Click Options on the Home tab, and then select More Options to open the Edit Seings window.
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Note:  Most dashboard options can be selected from the Options buon without opening the Edit
Seings window.

2. Enter eld information.

Field Description

Time Zone
 

Click this drop-down menu to select the time zone to be used with the dashboard’s
reports. The dates and times listed in the report output, lters, and parameters are
adjusted according to the time zone that is specied. The available options are:
 
Same as Interface—The time zone is the same as that set for the interface. This is the
default seing.
 
Same as Account—The time zone is the same as that of the sta member who is using
the dashboard. See Add or Edit a Sta Account.
 
A specic time zone you can select from a list of standard time zones.
 

Owner
 

Click this drop-down menu to select a dashboard owner. Only the dashboard’s owner
can view or edit the dashboard, unless the owner makes the dashboard public and
grants permissions to other proles. See Set Dashboard Permissions.
 
Changing the owner of a private dashboard makes the dashboard unavailable to the
previous owner.
 

Open dashboard without prompting
for search parameters
 

Select this check box to open the dashboard using the default runtime lters for the
reports. If this check box is not selected, the Search window opens for the dashboard’s
reports before the dashboard is displayed. Selecting this check box does not prevent
the Search window from opening if a report has a required runtime lter. See How You
Search Dashboard Reports.
 

Refresh dashboard when data
shown is changed due to an action
initiated from this dashboard
 

Select this check box to automatically refresh the dashboard’s reports when you initiate
an edit from one of the reports in such a way that the reports’ contents would change.
The dashboard is refreshed only if a record is edited in such a way that the record no
longer matches the dashboard reports’ search criteria.
 

Combine lters on the same eld in
search dialog
 

Select this check box to combine lters on the same eld used in multiple reports on the
dashboard. For example, multiple reports on the same dashboard might all have lters
to search by contact email address. If this check box is selected, the dashboard’s Search
window joins these into one common lter for this eld. All the reports that have this
lter are ltered on the search value entered for the common lter.
 

Combine lters with the same name
and type in search dialog
 

Select this check box to combine lters that have the same name and lter on dierent
elds with the same data type. For example, if there are two lters both named Contact,
 and one lter searches a text eld for rst name, and the other searches a text eld for
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Field Description

last name, these lters can be joined into one common lter. The search value entered
for the common lter is checked against both the rst name and last name elds.
 

Cache the drilldown levels for all
reports
 

Select this check box to automatically cache the data in report levels when they are
displayed. When you open a dashboard with this option enabled, the data shown on
the reports’ initial output levels is stored on your workstation. When you drill down
on a report to view another output level and then return to the report’s top level, it
loads quickly since the data you’re viewing is cached on your workstation. The cache is
cleared when you close the dashboard.
 
If this option is not selected, the database is queried every time you view an output level
to ensure the most recent data is displayed even if you have already viewed the level.
This default functionality can result in longer page load times than necessary when
viewing reports with data that does not change frequently.
 
This option is also available for individual reports. When using a dashboard that has this
option enabled, the dashboard’s seing overrides the seings in the dashboard’s report.
 

Undock docked lters
 

Select this check box to not dock lters on the dashboard that are docked in the
dashboard’s reports. If this check box is not selected and a report on the dashboard
includes docked lters, the lters are displayed in the dashboard’s Search window, and
are also docked above the reports in the dashboard.
 

Allow server to change the data
source as necessary
 

Select this check box to allow the data source to automatically change if necessary
to allow the dashboard to run. For example, if a dashboard is congured to run on
the operational database but is unable to do so due to data constraints, selecting this
check box allows the dashboard to run on the report database (also referred to as the
replication database). Clearing this check box forces dashboards to run on the data
source that is selected.
 
This check box is cleared automatically any time the data source is changed on the Edit
Seings window.
 

Set report to deferred execution
 

Select this check box to automatically queue the dashboard when it runs.
 
If the dashboard is automatically queued the next time it is run due to meeting queuing
criteria, this option is selected automatically. To prevent the dashboard from being
queued when it is next run, edit the dashboard and clear this check box.
 

Data Source
 

Select which database you want the dashboard to run on. You can choose the
operational or the report database. See Overview of Report Databases for information
about these data sources.
 
This option is available only if your site has a report database. If your site does not have
a report database, contact your Oracle account manager for more information.
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Field Description

Operational Database
 

Select this option if you want the dashboard to run on your operational database. This
option is helpful if you need the dashboard to return the most current data available.
 

Report Database
 

Select this option if you want the dashboard to run on your report database. This
option is helpful if your dashboard queries a large amount of data since the query size
restrictions on report databases are more relaxed than those on operational databases.
 

Refresh current drilldown levels
 

Select this check box to automatically refresh the data shown on drill-down levels
when the dashboard’s display is refreshed without returning to the top levels of the
dashboard’s reports. When this option is not enabled and the dashboard is refreshed,
drill-down levels shown on the dashboard automatically return to the top level of the
dashboard’s reports.
 

Automatically refresh dashboard at
a regular interval
 

Options in this section let you congure automatic refresh of the data shown in the
dashboard’s reports to ensure the most recent data is displayed.
 

Delay non-focused tab report
execution
 

Select this option to prevent reports on dashboard tabs you aren’t viewing from loading
in the background. Selecting this option can improve dashboard performance by
reducing the amount of time it takes for the dashboard to initially load.
 

Auto-refresh options visible at
runtime
 

Select this check box to add an arrow on the Home tab’s Refresh buon. Clicking the
arrow displays options to let sta members enable or disable automatic refresh and
change the interval time.
 
When this check box is not selected, the Refresh buon refreshes the dashboard’s data
only when the buon is clicked.
 

Auto-refresh enabled by default
 

Select this check box to enable automatic refresh of the data shown in the dashboard’s
reports.
 

Interval
 

Enter the number of seconds after which the data shown on the dashboard is
automatically refreshed.
 

Image
 

Click Change to select a dierent image to display next to the dashboard in lists such as
navigation lists. When selecting the new image, you can choose from a list of standard
images or from custom images that have been added in the Images explorer. See
Images Explorer.
 

Notes
 

Enter any text you want to add as a note to the dashboard. The note displays on the Edit
Seings window, but cannot be seen by individuals viewing the dashboard.
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3. Click OK.

How You Schedule Dashboards to be Sent  
You can schedule a dashboard to be sent to recipients or to be published in the same manner that reports can be
scheduled.

When a scheduled dashboard is sent, the recipients receive an email containing the dashboard in the format you select
when creating the schedule.

Note:  Dashboard schedules cannot have alerts applied as report schedules can, since dashboards do not have
data exceptions associated with them. In addition, dashboards cannot be sent to comma-separated values
(CSV) les.

To open a dashboard’s Schedules window, select the Scheduling buon on the Properties tab. See How You Schedule
Reports.

Set Dashboard Permissions  
A dashboard’s permissions specify the proles whose sta accounts can open or edit the dashboard. You can select
Open and Edit permissions for each prole dened in your system. Permissions applied to a private dashboard take
eect only when the dashboard is made public.

1. Edit a dashboard and click the Home tab.
2. Click Permissions.

The Permissions window opens.
3. To let sta members open the dashboard, select the check box next to their prole name. You can select

multiple proles.
4. To let sta members edit the dashboard, select the check box next to their prole name. You can select multiple

proles.
5. Click OK.

View the Dashboard Audit Log  
You can open an audit log for a dashboard to see when the dashboard was created, edited, run, and published, and
which sta members performed these actions. Since the audit log is a report, you can perform common report actions
on the audit log, such as printing, forwarding, or slicing.

The audit log shows you when the dashboard was edited and generated, but not all actions taken on the dashboard,
such as previewing it, are listed in the audit log. If you need to see every instance of a dashboard or report being
generated, printed, exported, and previewed, you can use the Expanded Report Audit Log. See View the Expanded
Report Audit Log.

1. Edit a dashboard and click the Home tab.
2. Click Audit Log.
3. To access a list of actions that can be taken on the audit log report, click Options. Many of the actions available

when viewing other reports are available on the Options buon. See Overview of the Report Ribbon for
descriptions of these actions.

4. Click OK.

How You Specify Dashboard Search Defaults  
You can specify search defaults for the reports in a dashboard.

When opening a dashboard, the dashboard’s reports automatically display with their default lter values, comparison
date osets, and output variables. However, you can select dierent defaults for the reports when they are opened from
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the dashboard by changing the dashboard’s parameter values. If your dashboard includes the Web Browser–Component
report, you can also specify a default URL for the web browser displayed in the dashboard.

You also have the option to set limits on the total number of rows returned in each report or the number of rows
returned on each page of the reports. In addition, you can enter Search Design Mode to modify the layout of the lters
on the dashboard’s Search window. For more information about searching for information in the reports shown in a
dashboard, see How You Search Dashboard Reports.

Set Dashboard Search Defaults  
You can change the default values set for the report parameters, for example you can specify the total number of rows
returned in the reports.

1. Edit a dashboard.
2. Click the Home tab.
3. Click Parameter Values to open the Set Filter Values window.

The window displays the runtime selectable lters, comparison periods, and variables that are in the
dashboard’s reports. If any of the reports have identical lters, comparison date osets, or output variables,
these are grouped together. You can also set limits on the number of rows returned on each page of the reports
or the total number of rows the reports can return.

4. Select the default values you want for the reports’ variables and lters.
5. To set record or page limits on the reports, select options in the Limit section of the Set Filter Values window.

a. Select the Limit To check box.
b. Enter the number of rows to return.
c. Select the Per Page check box to apply the entered row limit to each page of the report.

Note:  If the Per Page check box is not selected, the row limit you enter restricts the total number
of rows returned in the reports.

6. To clear the customized default search parameters specied for the dashboard, click Seings and select Reset
Values. When you do so, the dashboard’s default search parameters are reset to use the reports’ default search
parameters.

7. To modify the sizes and placement of the lters on the Search window, click Seings and select Enter Search
Design Mode. See Overview of the Search Window.

8. Click OK.

How You Customize Your Dashboard Display  
You can customize the appearance of your dashboards to make it more usable or presentable to your audience.

Numerous options are available to customize dashboard display. These include applying styles, selecting font aributes,
modifying sizing options, and adding titles to the dashboard’s reports.

Apply a Style to a Dashboard  
Dashboards can have report styles applied to them, just as individual reports can. When you apply a style to a
dashboard, all reports on the dashboard use the same style when viewed from the dashboard.

You can create your own styles, or choose from a number of default styles. Two of the default styles are intended for
specic purposes, though you can choose whichever style you want.

• Infolet—We recommend using this style with dashboards that primarily contain infolets. This style is formaed
to provide the most ecient use of space for viewing infolets. For information about infolets, see How You Place
Content on Dashboards.
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• Web Theme—This style is intended for use on the Browser User Interface. This is formaed to provide a
consistent look and feel when viewed in a web browser.

1. Click the Home tab.
2. Click Auto Format to open the Auto Format window.
3. To prevent the style from being applied to all levels in the reports shown on the dashboard, clear the Apply

Style to All Report Levels check box.
4. Click the style you want to apply to the dashboard.

The report style is automatically applied to all the reports in your dashboard. If you later add a new report to the
dashboard, you will need to apply the style to the dashboard again for the style to be applied to the new report. See
Apply a Style to a Report for information about applying a style to a report. For procedures on editing and creating
styles, see Styles Explorer.

Change Dashboard Display Options  
You can adjust the dashboard’s display options to add margins and titles to the reports in the dashboard. You can also
specify which report sections should display in the dashboard’s reports.

1. Click the Home tab.
2. Click Display Options to open the Display Options window.
3. In the Margins area, enter the number of pixels between the text and the left, right, top, and boom margins.
4. In the View Mode area, select an option to specify how you want the dashboard’s reports to scroll.

a. Screen—Select this option to add scroll bars to the individual reports in the dashboard.
b. Scrollable—Select this option to permit each report to display in its preferred size, with the height and

width of the items in each report xed. When this option is selected, a single set of scroll bars is added to
the dashboard so you can view the entire dashboard surface. However, if the entire size of the dashboard
exceeds 32767 x 32767 pixels, the dashboard’s reports may be clipped.

5. Click the Titlebars tab.
6. To display a report’s title above the report in the dashboard, select the check box next to the report.
7. Click the Report Sections tab.

This tab displays the common report sections included in the dashboard’s reports. Sections common to all
reports in the dashboard have a black check mark, sections that are not shared by all reports have a gray check,
and sections that are not in any of the reports have no check.

8. Select the check box next to each report section you want to display on the dashboard. To remove a section you
have already selected, clear the check box next to the section.

9. Click OK.

How You Preview Dashboards  
The Report view provides a preview of the dashboard.

When creating and editing dashboards on the dashboard designer, you generally use the Design view. This is the
default view used to edit the dashboard’s properties, and add reports, images, and text elds to the dashboard.

After you modify your dashboard, you can switch to the report view to preview what the dashboard will look like when
it is used by sta. When viewing a dashboard using the report view, the dashboard is presented to you just as your sta
members see it, though certain items, such as action links displayed in reports, are disabled. When you want to edit the
dashboard again, you can switch back to the design view.

Display a Dashboard Using the Report or Design Views  
You can choose to view the dashboard in either report or design view.

1. Edit or create a new dashboard. By default, the dashboard is shown in the design view.
2. Click the ribbon’s Home tab.
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3. Click the arrow on the Views buon and select Report View to change the view.
4. To view the dashboard with the design view, click the arrow on the Views buon and select Design View.

How You Use Dashboards  
You can open dashboards just as you would open a regular report from the Reports explorer or one of your navigation
lists.

Dashboards can also be opened from links you add to reports. When you open a dashboard, it loads with current report
data. You can also queue dashboards to view them at a later time.

The dashboard includes options similar to those accessed from the Report tab when viewing a report. The dashboard
also includes docked lters that are common to the reports in the dashboard and may include tabs to access reports on
other dashboard pages.

Every report in a dashboard is fully functional, so you can access the standard options available when viewing a report.
For instance, you can change the report’s sort order, modify column formaing options, and search for information
in only one of the dashboard’s reports. If the report and your permissions allow it, you can access records shown on a
report by double-clicking them, or by right-clicking them and selecting from menu options that display. Reports viewed
on dashboards also support inline editing, so you can quickly edit records shown on dashboard reports.

Overview of the Dashboard Ribbon  
When you open a dashboard, the dashboard’s ribbon includes Home and Page Setup tabs. You can use the options on
these tabs to print the dashboard and adjust the dashboard’s display and output.

When you select an individual report on the dashboard, the ribbon is updated to include additional tabs containing
options for modifying the selected report. These tabs are displayed next to the dashboard’s Home and Page Setup tabs,
and are grouped under a Report heading.

Note:  Some ribbon buons aren’t available when you view a published dashboard or a dashboard that’s run
after being queued.

Dashboard Tabs  
The buons on the Home and Page Setup dashboard tabs let you open the Search window, refresh the display, select
display options, forward the dashboard, congure print options, and perform other actions that impact the entire
dashboard.

Permission to export, print, and forward reports must be selected in your prole for the Page Setup tab and the Export
and Forward buons on the Home tab to display. These permissions are described in Analytics Permissions. See
Dashboard Designer Page Setup Tab for descriptions of the buons on the Page Setup tab.

Group/Buon Description

Data Set
 

The buons in this group let you search for data in all the dashboard’s reports, refresh the display, and
reset the search criteria to the dashboard’s defaults.
 

Search
 

Click this buon to open the dashboard’s Search window. See How You Search Dashboard Reports.
 

Refresh Click this buon to refresh the dashboard’s data using the current search criteria.
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Group/Buon Description

   
If the auto-refresh feature is enabled, an arrow displays on the buon. Clicking the arrow displays
options to let sta members enable or disable automatic refresh and change the interval time for
automatic refresh of data. See Edit Dashboard Options.
 

Reset
 

Click this buon to reset the dashboard’s search criteria to the defaults and regenerate the dashboard
using the default search criteria.
 

Display
 

The buons in this group let you modify how the dashboard is displayed. For example, you can apply a
style to all the reports on the dashboard to give them a similar appearance.
 

Screen
 

Click this buon to display all the dashboard’s reports on the screen when the dashboard is run. Each
report can have separate scroll bars to view the report contents.
 

Scrollable
 

Click this buon to display all the contents of each report on the dashboard. When this option is
selected, each report displays in its preferred size and the height and width of the items in each report
are xed. Separate reports do not have separate scroll bars, but vertical and horizontal scroll bars are
added to the dashboard if needed to display the entire dashboard.
 
If the entire size of the dashboard exceeds 32767 x 32767 pixels, dashboard contents are clipped when
using scrolling.
 

Display Options
 

Click this buon to change the dashboard’s width, add report title bars, and select which report
sections you want to display. See Change Dashboard Display Options.
 

Auto Format
 

Click this buon to apply a style to all the reports in a dashboard. This overrides styles applied to the
individual reports. See Apply a Style to a Dashboard.
 

Dashboard
 

The buons in this group let you export the dashboard, forward the dashboard in an email, and save
and restore default seings.
 
Permission to export, print, and forward reports must be selected in your prole for the Export and
Forward buons to display. See Overview of Sta Management.
 

Export
 

Click this buon to export the data from the dashboard’s reports to a le for use with third-party
applications. You can export the dashboard in HTML, PDF, Excel, XML, Image, Clipboard, and Delimited
formats. Reformaing of report layouts will occur when exporting dashboards in certain formats.
 
Dashboards exported in the Excel format are laid out vertically, and the reports’ row and column
spacing are reset so the data displays sequentially.
 
Dashboards exported in XML and delimited formats do not retain their report layouts, and the data is
displayed sequentially.
 
Dashboards exported in HTML, Image, and PDF formats retain their report layouts. However,
 dashboards that span multiple pages are arranged vertically when viewed in PDF format.
 
Dashboards and reports are exported using the same method and can be exported in the same
formats. See Export Report and Dashboard Data for more information about these formats.
 

Forward
 

Click this buon to send the dashboard to individuals or distribution lists in an email. Dashboards and
reports are forwarded using the same method. See Forward a Report.
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Group/Buon Description

Default Seings
 

Click this buon and select Save as Default to save your personalized display and data seings for
a dashboard for later use. Select Restore to remove personalized display and data seings from a
dashboard and restore the seings to those dened in the dashboard. See Reset Display and Data
Seings.
 

Sections
 

The options in this group let you select whether to show the dashboard’s header, footer, and
description.
 

Dashboard Header
 

Select this check box to show the dashboard’s header.
 

Dashboard Footer
 

Select this check box to show the dashboard’s footer.
 

Dashboard Description
 

Click this buon and select how the dashboard description should be displayed. You can choose to not
display a description, display the description inline, or display the description on a separate tab.
 

Report Tabs  
When you click a report on the dashboard to select it, the ribbon is updated to include the report’s Home, Display, and
Page Setup tabs.

You can use the buons on these tabs to perform the same actions you could if viewing the report outside of a
dashboard. For example, you can add calculations, select elds to show in the report, sort the report output, and edit
records. For descriptions of the buons on these tabs, see Overview of the Report Ribbon.

Display and Hide Dashboard Reports  
When viewing a dashboard, you can use buons displayed in each report’s title bar to minimize, maximize, or close each
report. This allows you to simplify the dashboard display when you want to focus on certain reports in the dashboard.

1. Open the dashboard you want to view.
2. Click one of these buons on the titlebar of the report you want to hide or display.

Buon Description

Minimize Click this buon to minimize the report. When a report is minimized, the report name
and icon display in the lower left corner of the dashboard. To restore the report, right-
click the minimized option and select Restore.
 
This buon is not available when the dashboard is displayed with a scrollable view
mode.
 

Maximize Click this buon to maximize the report. When a report is maximized, the other reports
in the dashboard are hidden.
 
This buon is not available when the dashboard is displayed with a scrollable view
mode.
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Buon Description

Restore Click this buon in the maximized report’s title bar to return the report to its previous
size.
 

Close Click this buon to close the report and temporarily remove it from the dashboard. The
report displays the next time you load the dashboard.
 
This buon is not available when the dashboard is displayed with a scrollable view
mode.
 

Related Topics
• Change Dashboard Display Options

How You Search Dashboard Reports  
You can search for information shown in dashboard reports.

While searching for information in reports in a dashboard is similar to searching the reports when they are generated on
their own, there are some dierences:

• Docked lters—When a report that includes docked runtime lters is run outside of a dashboard, the docked
lters display at the top of the report. However, when the report is opened in a dashboard, the report’s docked
lters are displayed at the top of the dashboard.

If multiple reports in the same dashboard include docked lters, all the reports’ docked lters are displayed at
the top of the dashboard. If two or more reports in the dashboard have the same docked lters, these can be
merged so only one docked lter displays. Values you set in the merged lter are applied to all reports with that
lter. See Edit Dashboard Options for information about combining lters for dashboard reports.

• Search window—When reports are displayed together on a dashboard, you can search for information in all the
reports simultaneously. Searching for information in a dashboard is similar to searching for information in a
report, though a dashboard’s Search window displays lters common to multiple reports, followed by report-
specic lters. These common and report-specic lters are separated by headers on the dashboard’s Search
window. See How You Search in Reports.

Search All Reports on a Dashboard  
You can perform a search in all reports on a dashboard.

1. Open the dashboard and click the Home tab.
2. Click Search to open the dashboard’s Search window.
3. Select the lters, variables, and limits you want.
4. Click OK to apply the search criteria to all the reports on the dashboard.

Note:  Certain options you select when creating dashboards impact the behavior of the Search
window. For example, if you select the Open Dashboard Without Prompting for Search Parameters
option on the Edit Seings window, the Search window automatically opens when you open the
dashboard. See Edit Dashboard Options for information about these options.

5. To search a specic report on the dashboard without searching the dashboard’s other reports, select the report
on the dashboard, click the report’s Home tab, and then click Search.
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Search in a Single Report on a Dashboard  
You can search for information in a specic report on a dashboard.

1. Open the dashboard.
2. Select the report on the dashboard you want to search.

Additional ribbon tabs display when you select a single report on the dashboard.
3. Click the Home tab beneath the ribbon’s Report heading.
4. Click Search.

The report’s Search window opens. The search you perform from the report’s Search window applies only to
the selected report.

5. Enter the search criteria you want in the Search window and click Search.

The search returns information in the selected report. The other reports on the dashboard are unchanged.

How You Queue Dashboards  
Dashboards can be queued to run at a later time just as reports can.

Dashboards can be manually queued or automatically queued. After a queued dashboard generates, you can view
the dashboard using a standard report or a notication just as you can with queued reports. See Overview of Queuing
Reports.

Note:  Unlike queued reports, you cannot send queued dashboards to comma-separated values (CSV) les.

Queue a Dashboard Manually  
You can queue dashboards containing reports that you think may query or return large amounts of data. This is also
helpful if you want to view a number of dashboards but do not want to wait for each to generate.

1. Do one of the following:
◦ Select the dashboard on the Reports explorer and click Queue.

◦ Right-click the dashboard, either on the Reports explorer or the navigation list, and select Queue.

The Queue Search Filters window opens where you specify the search parameters you want to use for the
queued dashboard.

2. Enter the search parameters you want to use. See How You Search Dashboard Reports.
3. Click Queue.

A window displays an approximation of when the dashboard will be available to view.
4. Click OK.

Automatically Queue a Dashboard  
Dashboards can be forced to be queued automatically if needed.

When you aempt to open a dashboard, the queries that are required to run each of the dashboard’s reports are
examined. If the system determines that one or more of the reports will take too long to process, a message displays the
reports in the dashboard that are causing the problem and asks if you want to queue the dashboard. If you choose to
queue the dashboard, it is queued to run at a later time using the search parameters you entered and a message shows
you the estimated time when the dashboard will be ready for viewing. If you choose not to queue the dashboard, you
can try to run it again using more restrictive search parameters.

Tip:  You can force dashboards to be queued automatically by enabling the Set Report to Deferred Execution
option on the Edit Seings window. See Edit Dashboard Options.
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How You View Queued Dashboards  
You can access queued dashboards from the Reports Explorer.

After you queue a dashboard, you can use standard reports located in the Reports Explorer (Public Reports/Common/
Site Administration/Reports) to see the dashboard’s status in the queue. After the dashboard runs and is ready to
view, you’re notied and you can open it from several locations. Most of the standard options are available on the
dashboard’s ribbon, though there are some exceptions.

It is possible that some of the reports in the dashboard will not queue successfully, for the reasons described in Why
Reports Fail to Queue. If a report in a dashboard can’t be queued, the queued dashboard can’t be processed.

The methods to view and open dashboards that have been queued are identical to those used with queued reports. See
How You View Reports in the Queue.

Conguration Seings that Impact Reports  

Analytics Conguration Seings  
A number of conguration seings can impact report performance and output.

The seings you should be aware of are described in the following topics, and are organized by the folders and
subfolders where they are located. For information about modifying conguration seings, see Overview of Site
Conguration.

CAUTION:  Changes made to site conguration seings can greatly impact the performance and functionality
of your entire site. Before you change any site conguration seing, it is important that your organization
understands the impact of changing the seing.

Common Conguration Seing for Reports  
Only one seing in the Common category impacts reports.

KF_ACTIONABLE_DATA_PURGE_DAYS is located in the Common/Knowledge Base folder. This seing allows you to
specify the number of days that daily actionable knowledge base reporting statistics are stored in the database. To
prevent these statistics from being removed, set this value to 0. The default value for this seing is 45 days.

RightNow Common Conguration Seings for Reports  
The conguration seings described here are located in the RightNow Common folder. These seings let you adjust a
number of values that impact what information is available in certain reports, the maximum size of generated reports,
date and time formats, and other aspects of reporting.

To… Use this seing…

RightNow Common/Service Modules/Clustering Field

Enable clustering and the use of clustering
information by other modules.

CLUST_ENABLED
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To… Use this seing…

 
The default value for this seing is enabled
(Yes).
 

RightNow Common/General Analytics Options/Server Options

Specify how many days charts and
other images in scheduled reports and
forwarded reports are kept. Scheduled
reports use the “stored on the server”
formats and forwarded reports use the
HTML aachment option. The maximum
is 90 days.
 
The default value for this seing is 14.
 

KEEP_EMAILED_IMAGES
 

Specify the maximum le size, in bytes,
 the Web server can return to the client
when generating a report. The maximum
value for this seing is 2147483647 (2 GB).
 
The default value for this seing is
15728640 (15 MB).
 

MAX_ANALYTICS_FILE_SZ
 

Specify the number of days after which the
information used in audit logs is deleted.
This value does not apply to the data used
by the Expanded Report Audit Log.
 
The default value for this seing is 10.
 

PURGE_REPORT_RUN_AUDITS
 

RightNow Common/General Analytics Options/Report Options

Specify the choice of the From address
when a report is emailed as a subscription
or when using the Send To feature. The
accepted values are: 1 - The From address
dened in the default mailbox for the
interface. 2 - The email address of the sta
member who owns the scheduled report
and/or sends the report.
 
The default value for this seing is 2.
 

RPT_FROM_ADDR
 

RightNow Common/General Analytics Options/Custom Scripts

Specify the size of the data buer (in
bytes) used when processing custom
scripts in Analytics.
 
The default value for this seing is 50000.
 

CUSTOM_SCRIPT_DATA_SIZE
 

RightNow Common/General Analytics Options/Group Date Format

Specify the format string used in the
predened group date list for output

GRP_DT_DATE_DAY_FMT
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To… Use this seing…

variables, if the user selects grouping by
Year/Month/Day at runtime.
 
The default value for this seing is YYYY/
MM/DD.
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Year/Month/Day/Hour at runtime.
 
The default value for this seing is YYYY/
MM/DD/HH24.
 

GRP_DT_DATE_HOUR_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Year/Month at runtime.
 
The default value for this seing is YYYY/
MM.
 

GRP_DT_DATE_MONTH_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Year/Quarter at runtime.
 
The default value for this seing is YYYY/
Q.
 

GRP_DT_DATE_QUARTER_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Year/Week at runtime.
 
The default value for this seing is YYYY/
WW.
 

GRP_DT_DATE_WEEK_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Year/Week Start at runtime.
 
The default value for this seing is YYYY/
WWW.
 

GRP_DT_DATE_WEEK_START_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Day of Month at runtime.
 
The default value for this seing is DD.
 

GRP_DT_DAY_OF_MONTH_FMT
 

Specify the format string used in the
predened group date list for output

GRP_DT_DAY_OF_WEEK_FMT
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To… Use this seing…

variables, if the user selects grouping by
Day of Week at runtime.
 
The default value for this seing is DAY.
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Hour at runtime.
 
The default value for this seing is HH24.
 

GRP_DT_HOUR_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Month/Day at runtime.
 
The default value for this seing is MM/
DD.
 

GRP_DT_MONTH_DAY_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Month at runtime.
 
The default value for this seing is MM.
 

GRP_DT_MONTH_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Quarter at runtime.
 
The default value for this seing is Q.
 

GRP_DT_QUARTER_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Week at runtime.
 
The default value for this seing is WW.
 

GRP_DT_WEEK_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Week Start at runtime.
 
The default value for this seing is WWW.
 

GRP_DT_WEEK_START_FMT
 

Specify the format string used in the
predened group date list for output
variables, if the user selects grouping by
Year at runtime.
 
The default value for this seing is YYYY.
 

GRP_DT_YEAR_FMT
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RightNow User Interface Conguration Seings for Reports  
Several conguration seings that impact Analytics are located in the RightNow User Interface folder.

Description Conguration Seing

RightNow User Interface/Misc. Customization/Query

Species the maximum number of rows
that can be displayed in a report. Limiting
the number of rows prevents inecient
reports from returning more rows than
can be quickly processed and displayed.
If the number of rows returned in a report
exceeds this number, the remaining results
are not displayed.
 
The default value for this seing is 10000.
This seing is ignored when sending
queued or scheduled reports to comma-
separated values (CSV) les. See Overview
of Queuing Reports and How You Schedule
Reports.
 

VRL_HARD
 

RightNow User Interface/Support/General

Species the number of days after which
solved incidents are no longer fully
searchable. Solved incidents whose closed
dates are older than the number of days
specied only support searching on
keywords in the subject. Set this value
to 0 or to a value greater than the value
in ARCHIVE_INCIDENTS to disable this
feature.
 
Sites with less than 1 million rows in the
incidents table are not aected. Default is
366.
 

PURGE_DELETE_INCIDENT_PHRASES
 

Agedatabase Conguration Seings for Reports  
The conguration seings described here are located in the Agedatabase folder. These seings let you set the
aggressiveness of the utility’s data caching and purging, and specify values used by certain opportunity tracking reports
that use cached data.

The Agedatabase utility automatically runs on the server hosting your Oracle Service Cloud site. The utility’s main
function is to perform automatic maintenance on your knowledge base (for example, aging incidents and answers).
However, Agedatabase also caches report data into individual report tables to make report generation more ecient,
and it purges old information that is no longer required for reports to help maintain the eciency of your database.

CAUTION:  Changes made to conguration seings can greatly impact the performance and functionality
of your entire site. Before you change any conguration seing, it is important that your organization
understands the impact of changing the seing.
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This table describes the Agedatabase conguration seings that impact reporting.

Description Conguration Seing

Agedatabase/Batch Processing/Miscellaneous Purging

Species the number of days after which
clickstream session summary statistics are
removed from the database. Set this value
to 0 to prevent this information being
removed from the database.
 
The default value for this seing is 60. The
minimum, non-zero value you can enter is
8.
 

PURGE_CS_SESSION_SUMMARY
 

Species the number of days after which
incident performance statistics are
removed from the database. Set this
value to 0 to prevent statistics from being
removed from the database.
 
The default value for this seing is 0.
 

PURGE_DELETE_INC_PERFORMANCE
 

Species the number of days after which
keyword search statistics are removed
from the database. Set this value to 0 to
prevent statistics from being removed
from the database.
 
The default value for this seing is 120.
 

PURGE_DELETE_KEYWORD_SEARCHES
 

Species the number of days after which
queue statistics are removed from the
database. Set this value to 0 to prevent
statistics from being removed from the
database.
 
The default value for this seing is 120.
 

PURGE_DELETE_QUEUE_STATS
 

Species the number of days after which
session summary statistics are removed
from the database. Set this value to 0 to
prevent statistics from being removed
from the database.
 
The default value for this seing is 0.
 

PURGE_DELETE_SESSION_SUMMARY
 

Species the number of days after which
Techmail statistics stored in the Techmail
Filter Details (tm_lter_details) and
Techmail Statistics (tm_stats) tables will be
deleted. A value of 0 disables purging of
these tables.
 
The default value for this seing is 30.
 

PURGE_DELETE_TM_STATS
 

951



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Description Conguration Seing

Species the number of days after which
login/logout sessions are removed from
the user_trans table (relative to the logout
time). Set this value to 0 to prevent login/
logout sessions from being removed from
the database.
 
The default value for this seing is 0.
 

PURGE_DELETE_USER_TRANS
 

Species the number of days after which
voice statistics are removed from the
database. Set this value to 0 to prevent
statistics from being removed from the
database.
 
The default value for this seing is 90. For
sites with multiple interfaces, statistics are
removed from all interfaces based on the
interfaces’ smallest non-zero value for this
seing.
 

PURGE_DELETE_VOICE_STATS
 

Species the number of days after which
guided assistance session data will be
deleted. Set this value to 0 to prevent
session data from being deleted.
 
The default value for this seing is 30.
 

PURGE_GUIDE_SESSIONS
 

Species the number of days after which
guided assistance statistics are removed
from the database. Set this value to 0 to
prevent statistics from being removed
from the database.
 
The default value for this seing is 0.
 

PURGE_GUIDE_STATS
 

Species the number of days after which
les that store the output from queued
reports and dashboards are deleted.
 
The default value for this seing is 7 days.
 

PURGE_QUEUED_REPORT_DAYS
 

Species the number of days after
which Rule Log entries are deleted. The
maximum value for this seing is 180.
A value of zero results in the data being
deleted after 180 days.
 
The default value for this seing is 30.
 

PURGE_RULE_LOG_FREQ
 

Species the number of days after which
data in the Social Monitor Statistics (sm_
stats) table is deleted. This seing is not
interface specic, so Agedatabase will use
the smallest value specied in any of your
interfaces to determine how often to purge
the data. A value of 0 disables purging.

PURGE_SM_STATS
 

952



Oracle Service Cloud
Using Service Cloud

Chapter 4
Analytics

Description Conguration Seing

The maximum value for this seing is
1825.
 
The default value for this seing is 1095.
 

Agedatabase > Batch Processing > Opportunities
 

Species the day of the week that the
opportunities table is cached for the
current sales period(s). Values refer to the
day of week, with 1 being Sunday, 2 being
Monday, and so on. A value of 0 disables
opportunity caching.
 
The default value for this seing is 6
(Friday).
 

OPP_SNAPSHOTS_SCHEDULE
 

Agedatabase/Batch Processing/Gap Analysis

Species how frequently (in days) the
Information Gap report is generated.
 
The default value for this seing is 7.
 

GAP_FREQUENCY
 

Species the time period reported on in
the Information Gap report. The report
will analyze incidents created during the
specied number of days.
 
The default value for this seing is 7.
 

GAP_TIME_PERIOD
 

Agedatabase/Batch Processing/Sales Performance

Species the quota aainment threshold
as a percentage that a given salesperson
should meet to be classied as a “Top
Performer.”
 
The default value for this seing is 95.
 

SALES_TOP_PERFORMER_THRESHOLD
 

Species the relative value from 1-10
of money versus opportunity counts in
reviewing a salesperson or group’s current
performance. A value of 5 means they
are treated equally. A value of 7 means
that total monetary value of opportunities
is more important than the number of
opportunities. A value of 3 means that
the number of opportunities is more
important than the total value of those
opportunities.
 
The default value for this seing is 5.
 

SALES_TP_METRIC_BALANCE
 

Species the relative value from 1-10 of
a salesperson or group’s closed revenue

SALES_TP_REL_VALUE_CLOSED
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Description Conguration Seing

in reviewing current performance.
This value is relative to the other
SALES_TP_REL_VALUE_* conguration
seings.
 
The default value for this seing is 5.
 

Species the relative value from 1-10 of
a salesperson or group’s lost revenue
in reviewing current performance.
This value is relative to the other
SALES_TP_REL_VALUE_* conguration
seings.
 
The default value for this seing is 5.
 

SALES_TP_REL_VALUE_LOST
 

Species the relative value from 1-10 of
a salesperson or group’s closed revenue
of new business in reviewing current
performance. This value is relative to
the other SALES_TP_REL_VALUE_*
conguration seings.
 
The default value for this seing is 5.
 

SALES_TP_REL_VALUE_NEW_BUSINESS
 

Species the relative value from 1-10
of a salesperson or group’s pipeline
in reviewing current performance.
This value is relative to the other
SALES_TP_REL_VALUE_* conguration
seings.
 
The default value for this seing is 5.
 

SALES_TP_REL_VALUE_PIPELINE
 

Transactions Database Table  

Overview of the Transactions Database Table  
Many of the standard reports available in Oracle RightNow Analytics Cloud Service (Analytics) use data from the
database’s Transactions table.

The information in this table describes the actions taken on records (such as incidents, answers, and contacts) and
items (such as mailings, surveys, and quotes) in your database. For example, when an incident is created and then
assigned to a sta member, two entries are added to the transactions table. The rst entry describes when the incident
was created, who created it, and where it was created from. The second entry describes who the incident was assigned
to and when it was assigned.
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Due to the amount of information stored in the Transactions table, it can be challenging to write custom reports that use
information from the table. However, when you understand how to use the data in the table, you can create powerful
custom reports to output or lter on almost all actions taken on the records and items in your database.

• Transactions Database Table Field Descriptions for brief descriptions of all the elds in the Transactions table.

• Transactions Database Table Transaction Types for descriptions of the types of transactions and the records
and items they can apply to.

• Transactions Database Table Aribute and Description Fields for detailed descriptions of the Transactions
table’s aribute 1, aribute 2, aribute 3, and description elds.

Note:  You can view additional information about the Transactions (transactions) table and information about
other database tables in the data dictionary. You can access the data dictionary by clicking  Conguration >
Database > Data Dictionary   on the navigation pane.

Transactions Database Table Field Descriptions  
This table briey describes all the elds in the Transactions table.

Field Description

Account ID (acct_id)
 

The sta member who performed the transaction. This eld will be NULL for transactions not initiated
by a sta member.
 

Aribute 1 (id1)
 
Aribute 2 (id2)
 
Aribute 3 (id3)
 

These elds contain information specic to certain types of transactions taken on certain records and
items. The eld values will be NULL for many transactions.
 
See Transactions Database Table Aribute and Description Fields.
 

Aribute 4 (id4)
 

This eld contains the channel type for transactions describing Oracle RightNow Social Monitor Cloud
Service (Social Monitor) activity. This eld is populated only for the Response Sent (8), Message Sent
Failure (15), Cloud Response Queued (37), Cloud Response Received (51), and Cloud Result Appended
(53) transaction types. The available values for this eld are:
 

1. CSS Email
2. MA Email
3. Phone
4. Fax
5. Post
6. CSS Web
7. MA Web
8. Chat
9. Email

10. Community
11. Twier
12. YouTube
13. RSS
14. Facebook

Date Created (created)
 

The date and time the transaction occurred.
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Field Description

Date/Time (dm)
 

The scheduled date and time for a mailing. This value will be NULL for any other record or transaction
type.
 

Description (description)
 

This eld contains information specic to certain types of transactions taken on certain types of
records and items. This eld will be NULL for many transactions. See Transactions Database Table
Aribute and Description Fields.
 

Foreign Key (id)
 

The unique ID number of the record, such as an incident or contact, that the transaction aected.
 

Interface (interface_id)
 

The interface the transaction was performed in.
 

Client IP Address (ip_address)
 

The IP address where the transaction originated.
 

Source (source_lvl1—source_lvl2)
 

The component where the transaction occurred. Level-1 source codes are the general area of Oracle
Service Cloud, and level-2 sources are the specic component. See the data dictionary for descriptions
of the source codes.
 

Source Hierarchy (source_hierarchy)
 

The level-1 and level-2 sources displayed in a hierarchical menu.
 

Table Association (tbl)
 

The type of record or item the transaction occurred on, such as an incident, quote, or survey. See
Transactions Database Table Transaction Types.
 

Type (trans_type)
 

The type of transaction that occurred, such as a record being created or edited. See Transactions
Database Table Transaction Types.
 

Transactions Database Table Transaction Types  
The types of transactions stored in the Transactions table, and the types of records and items that the transaction types
can apply to, are listed in this table.

The numeric code for each type is shown in parentheses after the type name. The numeric code for each table is shown
after the table name.

Note:  Some transaction types listed in the table are intended for use only by Oracle Consulting Services.

Table Name Transaction Type

Incidents (1) • Created (2)

• Edited (3)

• Assigned (4)

• Status Changed (6)

• Time Billed Added (7)

• Response Sent (8)
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• Escalated (11)

• SmartAssist (12)

• Forwarded (14)

• Message Send Failure (15)

• Incident Proposed (16)

• Queue Changed (17)

• Forwarded by a Rule (21)

• Sent (24)

• Completed (25)

• Cloud Response Queued (37)

• Read (48)

• Cloud Response Received (51)

• Cloud Result Appended (53)

Contacts (2) • Created (2)

• Edited (3)

• Escalated (11)

• Moved (20)

• Opt-In (23)

• Invalid Email Flag Changed (35)

• Contact Password Reset (36)

• Email Changed (38)

• Email Alt1 Changed (39)

• Email Alt2 Changed (40)

• City Changed (41)

• Country Changed (42)

• Postal Code Changed (43)

• Province Changed (44)

• Street Changed (45)

• Sub-Object Move (47)

Organizations (3) • Created (2)

• Edited (3)

• Escalated (11)

Answers (9) • Created (2)

• Edited (3)

• Assigned (4)

• Access Level Changed (5)

• Status Changed (6)

• Escalated (11)

• Forwarded by a Rule (21)
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Meta-Answers (10) • Created (2)

• Edited (3)

Quotes (12) • Created (2)

• Edited (3)

• Status Changed (6)

• Quote Sent (22)

• Quote Forecasted (32)

• Quote Price Schedule Changed (33)

• Quote Template Changed (34)

Documents (51) • Created (2)

• Edited (3)

• Proof Message Sent (49)

• Document Deployed (50)

Contact Lists (52) • Created (2)

• Edited (3)

• Audience Counted (30)

• Purge (46)

Mailings (53) • Created (2)

• Edited (3)

• Assigned (4)

• Audience Counted (30)

Mailing Messages(54) • Edited (3)

• Status Changed (6)

• Sent (24)

• Mailing Error (28)

• Mailing Scheduled (29)

• CAN-SPAM Compliance (31)

Segments (79) • Created (2)

• Edited (3)

• Stage Changed (18)

• Audience Counted (30)

Opportunities (87) • Created (2)

• Edited (3)

• Assigned (4)

• Status Changed (6)

• Escalated (11)
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• Completed (25)

Tasks (106) • Created (2)

• Edited (3)

• Assigned (4)

• Status Changed (6)

• Escalated (11)

Flows (126) • Status Changed (6)

Surveys (127) • Created (2)

• Edited (3)

• Assigned (4)

• Survey Disabled (26)

• Advanced Mode (27)

• Audience Counted (30)

• Survey Reminder Sent (52)

Campaigns (163) • Created (2)

• Edited (3)

• Assigned (4)

Assets (542) • Created (2)

• Edited (3)

• Status Changed (6)

• Forwarded (14)

Transactions Database Table Aribute and Description Fields  
The aribute and description elds in the Transactions table contain information about events that occur on a number
of dierent record types.

The data in the aribute 1, aribute 2, aribute 3, aribute 4, and description elds vary depending on the transaction
type and the type of record or item the transaction is associated with.

Note:  These elds aren’t populated for all types of transactions or all combinations of transactions and
records. For example, the aribute 1 eld contains the IP address of the source of an incident creation, but the
value in this eld will be NULL for an answer creation or an incident escalation.

This table describes the contents of the aribute 1 eld for each transaction type. Transaction type ID numbers are
shown in parentheses.

Transaction Type Aribute 1 Description

Created (2)
 
Edited (3)

If the record type is an incident, this is the IP address of the incident’s source for both the Created and
Edited transaction types.
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Transaction Type Aribute 1 Description

 

Assigned (4)
 

This is the assigned group.
 

Status Change (6)
 

This is the new status.
 
To lter reports on incident, answer, or opportunity status changes, we recommend using the Status
eld (status_id) in the Incident Statuses (inc_statuses), Answer Statuses (ans_statuses), or Opportunity
Statuses (opp_statuses) tables. The Transactions table can be used for this purpose, but additional
steps are required.
 

Response Sent (8)
 

This is the sta member who sent the response.
 

Forwarded (14)
 

This is the sta member who forwarded the record.
 

Message Send Failure (15)
 

This indicates the type of transaction that failed:
 

• 8–Response sent

• 14–Forwarded

• 21–Forwarded by a rule

• 22–Quote sent

Incident Proposed (16)
 

This is the answer that was created from the proposed incident.
 

Queue Changed (17)
 

This is the queue the record is assigned to.
 

Stage Changed (18)
 

This is the stage the opportunity was moved to.
 

Quote Sent (22)
 

This is the sta account that sent the quote.
 

Opt In (23)
 

If the value in the transaction’s aribute 2 eld is 1, this is the custom eld.
 

Sent (24)
 

This is the survey that was sent.
 

Completed (25)
 

This is the survey that was completed.
 

Disabled (26)
 

This indicates if the survey is disabled:
 

• 0–Active

• 1–Disabled

Advanced Mode (27)
 

This indicates if the survey is in Advanced mode:
 

• 0–Not in Advanced mode

• 1–In Advanced mode
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Transaction Type Aribute 1 Description

Mailing Error (28)
 

This is the code associated with the mailing error. For a descriptions of the error codes, refer to the
error details (error_code) eld in the Mailing Messages (mailing_formats) table in the data dictionary.
You can access the data dictionary from the Conguration buon on the navigation pane at Database
> Data Dictionary.
 

Audience Counted (30)
 

This is the audience count at the time it was counted.
 

CAN-SPAM Compliance (31)
 

This is a bit mask that indicates the results of CAN-SPAM compliance testing.
 

Quote Forecasted (32)
 

This indicates if the quote was forecasted:
 

• 0–Not forecasted

• 1–Forecasted

Quote Price Schedule Changed (33)
 

This is the schedule for the associated price schedule.
 

Quote Template Changed (34)
 

This is the action that was performed on the template:
 

• 1–Add

• 2–Update

• 3–Delete

Invalid Email Flag Changed (35)
 

This indicates if the primary email address was set to Invalid:
 

• 0–Not set to Invalid

• 1–Set to Invalid

Password (36)
 

This indicates if the password was manually changed or reset:
 

• 0–Changed

• 1–Reset

Cloud Response Queued (37)
 

This is the sta member who queued the cloud response.
 

Country Changed (42)
 

This is the country the contact’s address was changed to.
 

Province Changed (44)
 

This is the province (or state) the contact’s address was changed to.
 

Sub-Object Move (47)
 

This is the ID number of the secondary contact that was merged into the primary contact record.
 

Cloud Result Appended (53)
 

This is the ID number of the incident thread the cloud result is appended to.
 

This table describes the contents of the aribute 2 eld for each transaction type. Transaction type ID numbers are
shown in parentheses.
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Transaction Type Aribute 2 Description

Created (2)
 
Edited (3)
 

This is the queue the record is assigned to at the time of the transaction for both the Created and
Edited transaction types.
 

Assigned (4)
 

This is the sta member the record is assigned to.
 

Status Changed (6)
 

This is the group the sta member who performed the status change belongs to.
 

Response Sent (8)
 

This is the group the sta member who sent the response belongs to.
 

Forward (14)
 

This is the group the sta member who forwarded the record belongs to.
 

Message Send Failure (15)
 

This indicates the reason for the mailing error:
 

• 1–Unknown

• 2–Message disabled

• 3–No escalation action

• 4–Escalation disabled

• 5–Message queued

• 6–SMTP error

• 7–No valid recipients

• 8–Empty thread

Queue Changed (17)
 

This is the queue the incident was previously assigned to.
 

Stage Changed (18)
 

This is the strategy the opportunity was changed to.
 

Quote Sent (22)
 

This is the group the sta member who sent the quote belongs to.
 

Opt-In (23)
 

This indicates the type of the opt-in ag:
 

• 1–Custom eld

• 2–Global opt-in ag

Sent (24)
 

This is the account that is assigned to the record when the survey was sent.
 

Quote Template Changed (34)
 

This is the template used by the quote.
 

Invalid Email Flag Changed (35)
 

This indicates if the rst alternate email address was set to Invalid:
 

• 0–Not set to Invalid

• 1–Set to Invalid

Cloud Result Appended (53) This is the ID number of the cloud result.
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Transaction Type Aribute 2 Description

   

This table describes the contents of the aribute 3 eld for each transaction type. Transaction type ID numbers are
shown in parentheses.

Transaction Type Aribute 3 Description

Created (2)
 
Edited (3)
 

If the record was created from a call, this is the call the incident or opportunity was created from for
both the Created and Edited transaction types.
 

Assigned (4)
 
Status Changed (6)
 
Time Billed Added (7)
 
Response Sent (8)
 
Escalated (11)
 
Forwarded (14)
 
Message Send Failure (15)
 
Incident Proposed (16)
 
Forwarded by a Rule (21)
 

This is the queue the record was assigned to at the time of the transaction for all of these transaction
types.
 

Opt-In (23)
 

This indicates if the ag was enabled or disabled:
 

• 0–Disabled

• 1–Enabled

Quote Template Changed (34)
 

This is the template that was changed.
 

Invalid Email Flag Changed (35)
 

This indicates if the second alternate email address was set to Invalid:
 

• 0–Not set to Invalid

• 1–Set to Invalid

This table describes the contents of the description eld for transaction types that can have values in this eld. This eld
is NULL for most transaction types. The number in parentheses is the type’s ID number.

Transaction Type Description

Created (2)
 

If the new record is a meta-answer created from a proposed incident, this is the reference number of
the incident that was proposed.
 

Access Level Changed (5) This is a bit mask describing the answer’s new access level(s).
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Transaction Type Description

   

Response Sent (8)
 

This lists the email addresses (not including BCC) the response was sent to.
 

Escalated (11)
 

This is the new escalation level.
 

Forward (14)
 

This lists the email addresses the item was forwarded to.
 

Message Send Failure (15)
 

This lists the email addresses (not including BCC) that were to receive the message.
 

Incident Proposed (16)
 

This is the reference number of the incident that was proposed.
 

Forwarded by a Rule (21)
 

This lists the email addresses the record was forwarded to.
 

Quote Sent (22)
 

This lists the email addresses (not including BCC) the quote was sent to.
 

Email Changed (38)
 

This is the contact’s new email address.
 

Email Alt1 Changed (39)
 

This is the contact’s new Alt1 email address.
 

Email Alt2 Changed (40)
 

This is the contact’s new Alt2 email address.
 

City Changed (41)
 

This is the contact’s new city.
 

Postal Code Changed (43)
 

This is the contact’s new postal code.
 

Street Changed (45)
 

This is the contact’s new street address.
 

Proof Message Sent (49)
 

This lists the email addresses the proof message was sent to.
 

Document Deployed (50)
 

This is the name of the deployed document.
 

Cloud Response Received (51)
 

This is the name of the contact who sent the cloud response.
 

Cloud Result Appended (53)
 

This is the user name of the contact who posted the entry on Facebook or Twier.
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How to View the Database Data Dictionary  

View Your Database Data Dictionary  
You can use the data dictionary to view information about the tables and elds in your site’s Oracle Service Cloud
database.

The information returned in reports and dashboards is stored in your site’s database, allowing you to see vital
information about your customers, sta members, and interfaces. Using the data dictionary, you can view details about
all the tables and elds in the database, such as eld names, descriptions, and database types. You can add the Data
Dictionary component to any navigation list. See Change Your Navigation Pane Seings.

Note:  Not all the information in the database is accessible to Oracle RightNow Analytics Cloud Service
(Analytics).

1. Click Conguration on the navigation pane.
2. Expand Database, and then double-click Data Dictionary.

The content pane displays a list of all the tables in the database.
3. Click a table to view the table information.

The details that display depend on the table you have selected.

Field Description

Table Label Lists the descriptive table name used in the data dictionary throughout Oracle Service
Cloud.

Table Description Displays a description of the table.

Tbl Displays the table ID number.

Visibility Indicates the products and components that use the table, such as Service, Oer
Advisor, and Chat.

Custom Fields Indicates whether custom elds are allowed in the table.

Primary Key Lists the primary key columns. Click a column to view the column information.

Columns Lists the columns contained in the table. Click a column to view the column information.

Indexes Lists the indexed columns in the table. Click an indexed column to view the column
information.

4. To view column details, click a column in the Table Information section. The details that display depend on the
column you select.
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Field Description

Column Label Displays the descriptive column label used by the data dictionary throughout Oracle
Service Cloud.

Column Suxes Indicates the suxes that can be used with this column in analytics, such as .id or
.name.

Column Description Displays a description of the column.

Column Type Displays the type of column, such as menu eld or major join eld.

Data Type Lists the column data type, such as integer or varchar.

Length Lists the number of characters allowed in the eld.

Column Aributes Lists the column aributes, such as not nullable or unique.

Analytics Usage Indicates how the column can be used in analytics.
 

◦ All—Can be used anywhere in the report.

◦ Display—Can be used in a display column.

◦ Exception—Can be used in an exception.

◦ Filter—Can be used in a regular (node) lter.

◦ Group—Can be used to group.

◦ Group Filter—Can be used in a group lter.

◦ Join Filter—Can be used in a join lter.

◦ No Search—Can be used in a display column, exception, or group lter, and can be
used to group or sort.

◦ Search—Can be used in a regular, group, or join lter, and exception.

◦ Sort—Can be used to sort.

Joins Lists the columns that the selected column is joined to.
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5  Service

Incidents  

Overview of Incidents  
When customers request help through email or the Ask a Question page, or you respond to a social networking post
using the Social Monitor component, Service automatically creates incidents.

Most of the time, these are the incidents you will respond to. At other times, however, you will add incidents. For
example, when a customer contacts you by phone, fax, or mail, you will add an incident to create a record of the
customer’s question. When you work with customers to solve their support issues, you are instrumental in creating
a positive impression of your organization. As an agent, you are often the customer’s rst point of contact, and it is
important to resolve their concerns quickly and eciently the rst time. Oracle Service Cloud helps you do this by
providing comprehensive, accurate, and up-to-date information about all aspects of the customer’s communication
with your organization.

Besides providing you with all-encompassing information just when you need it, Oracle RightNow Cloud Service
(Service) gives you the tools to craft consistent, accurate answers to customer questions. It also lets you propose
incidents as answers, present oers to customers, and create opportunities from incidents.

When you edit or add an incident, you start by answering the customer’s question. Service provides help through
standard text, suggested answers, and the ability to search the knowledge base. You dene specic information about
the incident, such as the sta member it is assigned to, the associated products and categories, and the status and
disposition of the incident.

Working with incidents also gives you the ability to:

• Add or update contact information

• Track the amount of billable time you spend on the incident

• Add or edit tasks related to the incident

• Aach les to the incident

• View all actions taken on the incident

• Present promotional oers to the customer

You might also want to propose the incident as a permanent answer in the knowledge base. This lets customers to view
the answer without being required to submit a service request.

Note:  Service automatically handles email between separate Oracle Service Cloud sites. The site-specic
incidents are accurately updated on each site even if unique reference numbers are used for the same
incident. See Cross-Site Email Management.

Incident Reports  
This topic describes incident reports and what options are available.
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When you click the Incidents buon on the navigation pane, the navigation list displays all of the reports and items
added to this list by your administrator. The Incidents buon, plus all the other buons you have access to, are part of
the navigation set dened in your prole.

Incident reports can be placed in other navigation lists, not just the Incidents navigation list. And if you have permission
to customize your navigation set, you can add other items, including reports you have permission to access, to your
Incidents navigation list or any of your lists.

Double-clicking any incident report displays the report on the content pane. The incident information displayed on the
content pane depends on the incident report you opened and which elds were dened when the report was created.
The Incidents report, for example, displays the subject, status, the name of the agent it is assigned to, the queue it is
assigned to, the date it was last updated, and the associated reference number. The Home tab on the ribbon lets you
open, add, print, copy, assign, delete, forward, and propose incidents. In addition, you can send email to the contact
associated with an incident, search for an incident, refresh the report, or reset the search criteria. It also provides data
analysis options and options for working with the report. Additional tabs on the report ribbon include options for
controlling display and page setup.

Besides selecting an incident from a report, you can search for incidents from a report or use Quick Search.

Tip:  You can right-click any incident and select the same functions that are available on the incident report
ribbon.

Related Topics
• Record Search Options

Standard Incident Workspace  
This topic describes the standard incident workspace used when working on incidents.

Service provides a standard workspace for working with incidents. The workspace denes which elds are available,
which buons are displayed on the ribbon, and how the information is organized on the content pane.

Your organization can use the standard incident workspace, or your administrator might have created one or more
customized workspaces. Your prole denes the workspace you see when you work with incidents, whether it is the
standard workspace or a customized workspace. If you are using a customized workspace, keep in mind that the
workspace your prole uses may display a dierent combination of elds, or it may display them in a dierent location
on the content pane.

Related Topics
• Custom Workspaces

Incident Workspace Ribbon  
This table describes the buons on the ribbon of the standard incident workspace.

Group/Buon Description

Editor

Undock Click this buon to undock the incident editor from the console and display it in a separate window.

Save
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Group/Buon Description

Save Click this buon to save the incident you are working on. The incident remains open.
When you save an incident, the rules engine evaluates it. If incident rules exist and the incident
matches one or more rules, the record may be modied when you save it. For example, a rule can
change an incident’s disposition or add suggested answers to the Response eld of the Messages tab.
 

Save and Close Click this buon to save the incident you are working on and close the incident.

Send Click this buon to send the response you are working on to the primary contact and to anyone in the
CC and BCC elds if shown.

Actions
With the exception of the New buon, the buons in this group are not enabled until after you have saved an incident you are adding.
 

New Click this buon to add an incident.

Refresh Click this buon to refresh the current set of incident records.

Forward Click this buon to forward the incident to any email address, sta account, or group.

Print Click this buon to print the incident.

Copy Click this buon to copy the incident.

Delete Click this buon to delete the incident.

Proong

Spell Check Click this buon to check the spelling of any incident elds that have spell checking enabled.

Related Activities

Guided Assistance Click this buon and either select or search for a guide that will ask you questions before directing you
to information to help solve the incident.
This buon will not display until guided assistance is enabled and you have guided assistance
permission in your prole.
 

Propose Click this buon to propose the incident as an answer.
This buon is not enabled until after you have saved an incident you are adding.
 

Oer Advisor Click the buon to open the Oer Advisor window, which lets you present oers to the customer.
This buon is enabled when an oer is available.
 

New Opportunity Click this buon to create an opportunity that provides information about the incident to your sales
department.

Appointment Click this buon to add an Outlook appointment that is associated with the incident.

Links and Info

Links Click this buon to select a URL from the list of links added by your administrator.

Info Click this buon to see details about the incident, including the incident ID, when it was created and
last updated, the date when the initial response was due, the date of the last response, the date of the
initial response, the closed date, and the sta member who created it. If the incident has an escalation
level or is in a rules state, that information also appears.
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Related Topics
• Overview of Business Rules

• How You Present Oers

• Add an Incident

• Find Answers Using Guided Assistance

• Propose an Answer from an Incident

• Create an Opportunity from an Incident

Incident Record Tabs  
Using the incident record tabs, you can respond to the customer and add and edit other information relevant to the
incident. You can also work on the incident in stages if you choose, leing you save the changes and then return later to
complete your work.

The standard workspace for incidents includes these tabs.

• Messages—Contains elds that let you add a customer entry, response, or private note to the incident thread
and respond to the customer using either HTML or plain text. From this tab, you can also view suggested
answers from SmartAssistant, search the knowledge base for public answers, and insert standard text into your
response. See Add an Incident.

• Contacts—Lists all contacts associated with the incident. The number of contacts associated with the incident
displays in parentheses next to the tab name. You can add, open, print, copy, delete, remove, and email
contacts from the incident. See Add or Edit Contact Information.

• Details—Contains elds for collecting additional information about the incident, which is benecial for
reporting purposes. See Add Incident Information on the Details Tab.

• Time Billed—Lists all time billed entries for the incident. From this tab, you can add, open, and delete time
billed entries. See Add Time Billed to an Incident.

• Tasks—Lists all of the tasks associated with the incident. You can add, open, copy, delete, print, and forward
tasks and mark tasks complete. The Tasks tab displays a number in parentheses to show how many tasks are
associated with the opportunity. See Add or Edit a Task for an Incident.

• Organization—Lists the organization associated with the incident. See Edit an Organization Associated with an
Incident.

• Web Visit—Lists all actions the customer took before submiing the incident. Also provided are the client IP
address, operating system, and browser used by the customer during their visit. See View Web Visit Information
for an Incident.

• Aachments—Lists all les aached to the incident. For instance, if a customer forwards a document that
is associated with the incident, the Aachments tab provides a convenient location where you can store the
document for retrieval. You can add, open, download, delete, and view the properties of le aachments from
this tab. See Overview of the Aachments Tab.

• Audit Log—Contains a permanent list of all actions associated with an incident, including the date of the action,
who performed the action, what the action was, and a description of the action. This information is valuable for
tracking interactions with customers, especially if more than one sta member works on the same incident. See
Audit Logs.

Note:  If you make changes to elds on any of the incident record tabs or any of the subtabs or windows
opened through the record tabs (for example, the contact editing subtab), you must save the incident in order
for all changes on the record tabs to take eect. If you close the record without saving changes, those changes
are lost.
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Incident Creation  
This topic describes the process for working on incidents after a customer submits a question.

When a customer submits a question, Service automatically creates an incident that contains the subject, customer’s
question, and contact information. You can complete an incident response in a single editing session, or you might nd
it useful to work on one part of the response and then return later to complete the rest of the incident.

The standard incident workspace enables you to move quickly from one section to the next as you work on incidents.
You can edit any part of an incident in any order. The majority of incidents are assigned to you or pulled into your inbox.
When incidents are assigned to you, some information in the record is populated when you open the incident.

Fill Your Inbox  
If your prole has incident editing permission and queues assigned to it, you can click the Fill Inbox buon on the ribbon
of any incidents report displayed on the content pane.

When you click the Incidents navigation buon and double-click the default My Inbox report, the incidents that are
assigned to you are displayed. As you respond to and solve incidents, their status changes to Solved or Waiting. You can
continue to rell your inbox to retrieve new unresolved incidents.

1. Click Fill Inbox.
If your prole has been set to a manual pull policy, the Manual Queue Pull window opens and you can click
the arrow to select the queue to pull incidents from. If only one queue is congured to pull incidents from, the
Manual Queue Pull window does not display.

2. If the displayed incidents report does not display incidents by assigned sta member, open the My Inbox report
to view incidents that were added when you clicked Fill Inbox.
Unresolved incidents in any of the queues designated in your prole are available to be pulled. The order
in which you work on incidents is determined by the queue priority and any processes set up by your
administrator.

How You Edit Incidents  
The elds you see when adding or editing an incident are dened in a workspace that is assigned to your prole.

Some of the elds are required by default, and your administrator may require that other elds also be completed.
You must complete any eld marked with an asterisk before you can save the incident. Incidents do not have to be
completed in any particular order, but you must complete all required elds before you can save an incident.

This list provides the required and optional steps involved when editing an incident.

• Complete the incident elds. See Edit Key Incident Fields.

• Compose your response to the customer. See Incident Thread.

• To add content to your response, see Response Options.

• To add or edit contact information, see Add or Edit Contact Information.

• To track the time you spend editing the incident, see Add Time Billed to an Incident.

• To add or edit tasks associated with the incident or its contact, see Add or Edit a Task for an Incident.

• To add or edit organization information, see Edit an Organization Associated with an Incident.

• To present an oer to a customer who is eligible for one, see Present an Oer.

• To create an opportunity for the sales department to follow up, see Create an Opportunity from an Incident.
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• Send a response to the customer. See How You Send Incident Responses.

You can save the incident at any stage of the process and either continue editing or close the incident and return later to
complete it.

How Incidents are Evaluated by the Rules Engine  
When you save an incident, it is evaluated by the rules engine.

Your administrator may have added business rules to simplify and automate your work. For example, rules can
change incident elds, apply an SLA instance, add suggested answers to your response, and take many other actions
automatically. If you save an incident without closing it and the incident matches one or more rules, it is possible
that the incident was automatically modied by the rules engine. If you notice that changes have been made to the
incident, you may want to check with your administrator to verify that they are the result of rule actions. See Overview
of Business Rules.

Before you start editing incidents, you will benet from understanding what certain eld properties mean in order to
provide accurate responses to customers. This includes incident statuses and SLAs, as they play an important role when
you interact with customers.

Incident Statuses  
Incidents can have one of the four default incident statuses, or they may have a custom status dened by your
administrator. The default statuses are Unresolved, Solved, Updated, and Waiting.

Depending on how Service is congured in your organization, the status can change automatically when you or the
customer make changes to the incident. You can also change an incident’s status manually.

The following example describes how an incident’s status can change automatically.

1. A customer submits a question from the Ask a Question page. The new incident has a status of Unresolved.
2. The customer updates the question before you begin working on the incident. The incident remains

unresolved, but the incident status changes to Updated to reect the customer’s actions and alert you to the
change.

3. You edit the incident and send a response to the customer. Your system may be congured in either of the
following ways to automatically change the status, or it may be congured so that no status change occurs.

◦ The incident’s status changes to Solved.

Note:  Regardless of how your system is congured, the status of an incident automatically
changes to Solved when the customer selects “No, I don’t need this question answered now” on
the Question Details page or through the link in the email response. You will receive an incident
notication.

◦ The incident’s status changes to Waiting. The Waiting status signies that you have sent a response
and are waiting for the customer to let you know if this answers the question. If your system has this
conguration and the customer does not respond within forty-eight hours (the default time), the system
automatically changes the status to Solved and sends an email to the customer.

SLA Instance Field  
Another incident eld you may work with is the SLA Instance eld.

An SLA is a service level agreement. SLAs let your organization to assign and track customer service, such as the
number of questions a customer can submit through dierent channels and the duration of support.
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Both contacts and organizations can have SLAs, but contacts that are associated with an organization do not have
individual SLAs. Instead, their incidents are credited to their organization’s SLA. Only contacts that do not have an
organization association can have SLAs.

Your administrator creates an SLA, which is a generic service contract that has not been applied to any specic
customer. An SLA instance is a copy of the generic SLA applied to a specic customer. SLA instances can be applied
manually by sta members whose proles grant them permission to work with SLAs or automatically through business
rules in Service. (If you have read-only permissions for contacts, organizations, and incidents, you will see View in the
SLA Instance eld instead of Add or Edit.)

When you work on an incident for a customer who has an SLA, you can credit that incident to the SLA. If the customer
does not have an SLA, you must apply an SLA instance before you can credit the incident.

Related Topics
• Examples of Applying Service Level Agreements (SLAs)

Apply an SLA Instance to a Contact or Organization  
This procedure describes how to apply an SLA instance when you are working on an incident.

1. From an incidents report, right-click the incident and select  Open > Contact  or  Open > Organization .
2. Click Add (if no SLAs have been applied to the customer) or Edit in the SLA eld.

The SLA Viewer window opens. Any SLA instances that have already been applied to the customer are
displayed under SLA Instances.

Note:  If you select  Open > Contact  and the contact is associated with an organization, the SLA eld
contains “See organization for SLA Details.” Return to the incidents report on the content pane, right-
click the incident, and select  Open > Organization .

3. Click Add SLA Instance
The Add New SLA Instance window opens.

4. Click the Name drop-down menu and select an SLA.
5. Select an active date by clicking a day on the current month calendar (or, to change the month, click the right or

left arrow in the month heading). The date today is selected by default.
6. Click OK.

The Add New SLA Instance window closes and the SLA instance is added.
7. Click OK.

After an SLA instance has been applied to the customer, you can credit incidents submied by that customer against
the SLA instance as long as the incident occurs within the active date period. See Credit an Incident to an SLA Instance.

Credit an Incident to an SLA Instance  
After an SLA instance has been applied to the customer, you can credit incidents submied by that customer against
the SLA instance as long as the incident occurs within the active date period.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Click the Details tab.
3. Click the drop-down menu on the SLA Instance eld and select an SLA instance.

The incident is credited to the SLA instance you select.

Note:  Every time an incident is credited to an SLA instance, the number of available incidents is
reduced. When the last incident is credited, the customer’s SLA is disabled.

4. Click Save.
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If you have enabled resolution due calculations and the SLA has a response time dened, you will be able to view the
resolution due date and time after saving the incident. See Resolution Due Calculations.

Edit Key Incident Fields  
After understanding the role of incident statuses and SLAs, you can edit the key incident elds.

This procedure describes the standard incident workspace. Keep in mind that your workspace may contain dierent
elds. Fields marked with an asterisk are required elds and must be completed before you can save the incident.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Enter eld information.

Tip:  Use Find at the boom of drop-down menus when available to search quickly. Wildcards are
supported. You can search strings that include a space by entering %[spacebar][character],which
is helpful when searching last names. For example, when using the Find feature in the Assigned
eld, entering %[space bar]b returns all last names starting with the leer b. There is also an implied
wildcard when searching, so entering b in the Find eld returns all items containing the leer b.

Field Description

*Subject Enter a subject for the incident in this eld. If the customer originated the incident, this
eld contains the customer’s summary of the question, which you can edit if necessary.
For example, to make the question more specic.

Reference # The incident’s reference number is a read-only eld with a value assigned by Service.

*Status Click this drop-down menu and select an incident status. The options include Solved,
Unresolved, Updated, and Waiting, as well as any custom incident statuses added by
your administrator.

Assigned Click this drop-down menu and select a sta member to assign the incident to. On the
standard incident workspace, this eld contains your name by default.

Disposition Click this drop-down menu and select a disposition that indicates the resolution of the
incident. There may be multiple levels of dispositions for you to select.

*Contact Click Search to the right of the Contact eld to search for a contact to add to the
incident. To add a contact, click New Contact on the open Contact Search window.
If this eld contains a name, the customer will also be listed as the primary contact on
the Contacts tab. Be aware that if you add another contact using the Search buon,
 the existing primary contact is removed from the incident and replaced with the new
primary contact. To add a contact to an incident without removing the primary contact,
 use the Add buon on the Contacts tab toolbar.
 

Organization Name This read-only eld contains the name of the organization for the contact associated
with the incident.

Product Click this drop-down menu and select one or more product levels to indicate the
product for the incident.
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Field Description

Category Click this drop-down menu and select one or more category levels to indicate the
category for the incident.

3. To add a ag to the incident, click the area next to the white ag at the top of the content pane.
4. To add other key incident elds, click the Details tab.

Related Topics
• Reassign or Re-Queue an Incident

• Add or Edit Contact Information

• Add a Flag to a Record

• Add Incident Information on the Details Tab

Add Incident Information on the Details Tab  
The standard incident workspace contains a Details tab where you can enter additional information about the incident.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Click the Details tab.
3. Enter eld information.

Field Description

Mailbox Click this drop-down menu to select the mailbox to send the incident response from.

Source This is a read-only eld that identies the source of an incident, whether it is added by a
sta member or a customer.

Severity Click this drop-down menu to select a severity level for the incident. The severity level
serves as an importance indicator for any agents that work on the incident. The highest
severity incidents are usually solved rst.

*Interface Click this drop-down menu and select an interface.
By default, the incident’s interface is set to the interface where the incident was created.
The interface determines the language of the message bases used for automatic
responses to the incident.
 

Language Click this drop-down menu and select a language.
If your site has multiple interfaces for dierent languages, be sure you have also
selected the interface that uses the language you want used in the response to the
customer.
 

SLA Instance Click this drop-down menu to credit the incident to an SLA instance that has been
applied to the contact or the organization to which the contact belongs.

Queue Click this drop-down menu and select a queue into which to move the incident from
your inbox.
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Field Description

Custom Fields If your administrator has added incident custom elds, you can enter that information
on the Details tab.

Related Topics
• SLA Instance Field

• Add or Edit an Incident Severity Level

• Reassign or Re-Queue an Incident

Incident Threads  
The incident thread, which displays communication between the customer and agent, is located on the Messages tab.
Using the Rich Text Incident Thread control, you can display, edit, and respond to HTML-formaed emails, resulting in
richer interactions with your customers.

This image shows the thread control on the standard incident workspace (displayed by clicking File and selecting
Incident).

Legend for image: 1. Messages tab toolbar 2. Incident thread toolbar 3. Title bar 4. Uncommied threads panel 5.
Commied threads panel

If the customer submied the question through the customer portal, it also appears as a Customer Entry thread.
You can enter the question for the customer if, for example, you are responding to a phone call. This will appear as a
Customer Entry as well. Besides adding a Response thread, you can also add a Private Note thread, which can be read
by other sta members but not by customers.

When editing an incident, the default is Response (the default channel is Email). To save time and make your responses
accurate and consistent, you can add predened content, including SmartAssistant suggested answers or standard text.
You can also search for answers that are related to the customer’s question.

When an incident is created for a customer through the Social Monitor, social channels such as Twier and Facebook
will be available when responding. Instead of sending an email response to the customer, you can respond directly to
the social networking site where the post originated.

Note:  Whenever a valid incident reference number appears in any incident thread (Customer Entry, Response,
or Private Note), it is displayed in green text in the thread and is a link that opens the incident in a separate
workgroup when you click it. In order for Service to create a clickable link from an incident reference number,
the number must use the format ######-######.
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Related Topics
• WYSIWYG Toolbar

• How You Send Incident Responses

• SmartAssistant Suggested Answers

• How You Search the Knowledge Base

• Overview of Social Monitor

• Insert Standard Text from the Standard Text Window

• Insert Standard Text Using a Keyboard Shortcut

• Change the Account Overview Page Headings

Messages Tab Toolbar  
Using the Messages tab toolbar, you can choose the type of thread entry—customer entry, response, or private note—
when responding to the customer.

The thread title bars are color coded, making it is easy to dierentiate between them when adding or editing an
incident. On a new incident, the default thread type on the standard incident workspace is Customer Entry (the default
channel is Phone).

The Messages tab lets you send the response to the customer when you save it. You can send the incident response to
other recipients as well by adding their email addresses to the CC eld. Send response functionality also lets you aach
les to the incident and select secure email options.

Buon Description

Send on Save Select this check box to send your response to the customer when you save the incident.

Add Click this buon and select one of the following options to add a thread to the uncommied threads
panel.

Customer Entry Select this option to enter information about the customer. For example, select Customer Entry
when the customer’s question occurs during a phone call. This is the default option when you add an
incident.

Response Select this option to enter your response to the customer’s question. This is the default option when
you edit an incident.

Private Note Select this option to enter the text that you want to be viewed only by other sta members. Customers
cannot view this information.

SmartAssistant Click this buon to select one or more answers you can insert into your response as either text or a
URL link.

Search Knowledgebase Click this buon to search for answers to help you respond to the customer.

Standard Text Click this buon to select and insert a predened piece of information into the response. For example,
 you might select a greeting, closing, or response to a common question.

Options Click this buon to select thread type lters to modify your commied incident thread information
display, change the date sorting order for threads on the commied threads panel, and choose
message header display options for sending responses.

977



Oracle Service Cloud
Using Service Cloud

Chapter 5
Service

Note:  Your administrator controls the functions available on this toolbar. See Overview of Workspace and
Script Elements to view the list of individual functions.

Incident Thread Toolbar  
Using the incident thread toolbar, you can apply HTML formaing to threads while they display in the uncommied
threads panel.

When you save the incident, all uncommied (unsaved) threads are moved to the commied threads panel, where all
HTML formaing is retained. If the EGW_VISUAL_EMAIL conguration seing is disabled, all incoming email will display
as plain text even if it was sent as HTML.

Use the incident thread toolbar to:

• Cut, copy, paste, undo, and redo. If formaed content is copied from an external source and pasted into the
uncommied threads panel, all formaing is retained. To avoid reformaing pasted content, right-click and
select Paste as Text or press Ctrl+Shift+V.

• Change font style, size, and aributes (bold, italic, underline, strikethrough, text color, highlight).
Tip:  To make the font size in the incident and the response the same, see Answer ID 4857.

• When entering a response or customer entry thread, any changes to font style, color, or highlighting take
precedence over the styling used on the customer portal. As a result, contacts using the customer portal to
review agent responses may see unexpected font and color combinations.

• Left-justify, center, or right-justify text and images on the page.

• Format text in bulleted or numbered lists.

• Insert images by URL and upload images.

• Insert links.

• Increase and decrease indents.

• Apply specialized formaing, including sub and super script.

• View plain text, which removes all HTML formaing.

Note:  If formaed content is copied from an external source and pasted into the uncommied threads panel,
all formaing is retained. To avoid reformaing pasted content, right-click and select Paste as Text or press
Ctrl+Shift+V.

Related Topics
• Incident Thread

• Add a Response to an Incident

• Add a Customer Entry or Private Note to an Incident

Add a Response to an Incident  
Follow this procedure to add a response to an incident.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. If the Messages tab is not on top, click Messages. (On the standard incident workspace, this tab is displayed

when an incident is opened.)
3. If the Response option is not selected automatically, click Add and select Response.
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The Response title bar displays on the uncommied threads panel.

Note:  You can add multiple threads to the uncommied threads panel before saving the incident. To
edit or delete a thread, click Edit or Delete located on the right side of the title bar.

4. To identify a channel for a response, click the Email drop-down menu in the Response title bar and select one
of the following options: Phone, Fax, Post, CSS Web, or Email. (Email is the default channel on the Response
title bar.)
If an incident is created through the Social Monitor component, the social channel from which it arrived will
display by default on the Customer Entry title bar and will be available as an option in the Phone drop-down
menu.

5. Enter your response to the customer’s question. See WYSIWYG Toolbar.
When you save the incident, the uncommied threads panel closes and all uncommied threads are moved to
the commied threads panel. The commied threads panel expands so the incident threads are easier to read.
You can right-click in the commied threads panel and choose options for selecting, copying, and nding text.
The nd feature (which can also be opened by pressing Ctrl+F) can be useful for nding information quickly.

The thread control remains in this state until you add another response, customer entry, or private note. At that point,
the uncommied threads panel displays again.

Add a Customer Entry or Private Note to an Incident  
Follow this procedure to add a customer entry or private note to an incident.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. To add a customer entry, click Add and select Customer Entry. The Customer Entry title bar displays on the

uncommied threads panel.

You can add multiple threads to the uncommied threads panel before saving the incident. To edit or delete a
thread, click Edit or Delete located on the right side of the title bar.

a. To identify a channel for a customer entry, click the Phone drop-down menu in the Customer Entry title
bar and select one of the following options: No Channel, Phone, Fax, Post, CSS Web, or Email. (Phone is
the default channel on the Customer Entry title bar.)
If an incident is created through the Social Monitor component, the social channel from which it arrived
will display by default on the Customer Entry title bar and will be available as an option in the Phone
drop-down menu.

3. To add a private note, click Add and select Private Note.
a. To identify a channel for the private note, click the No Channel drop-down menu and select one of the

following options: No Channel, Phone, Fax, Post, CSS Web, or Email. (No Channel is the default channel.)
4. Enter the customer entry or note in the uncommied threads panel. See WYSIWYG Toolbar.

When you save the incident, the uncommied threads panel closes and all uncommied threads are moved to
the commied threads panel. The commied threads panel expands so the incident threads are easier to read.
You can right-click in the commied threads panel and choose options for selecting, copying, and nding text.
The nd feature (which can also be opened by pressing Ctrl+F) can be useful for nding information quickly.

The thread control remains in this state until you add another response, customer entry, or private note. At that point,
the uncommied threads panel displays again.

Response Options  
Service has tools that help you save time, eliminate mistakes, and provide consistent information to customers.
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These tools include the ability to aach links to answers in the knowledge base, insert the actual text of answers into the
response, search the knowledge base for specic answers to include, and insert standard, predened text.

• SmartAssistant Suggested Answers

• How You Search the Knowledge Base

• Insert Standard Text from the Standard Text Window

• Insert Standard Text Using a Keyboard Shortcut

• Find Answers Using Guided Assistance

SmartAssistant Suggested Answers  
SmartAssistant contains an autotuning feature that reviews the eectiveness of your current conguration and
automatically makes adjustments and suggestions to improve results.

A tuned, optimized SmartAssistant can improve incident deection rates and produce information that can be used
to rene the knowledge base and provide guidance to agents. The autotuner enhances the search algorithm by
closely tracking answers that have been appended to an incident thread as a link or text, or that an agent has explicitly
identied as the answer that best resolved an incident. SmartAssistant will then give greater deference to these
answers, as they are known to relate to or resolve issues submied as incidents.

In addition, the autotuner reviews the many conguration seings that inuence SmartAssistant results and
recommends changes to ensure that they are fully optimized. And to help you understand the value of these
recommendations and help you decide whether to accept them, their projected impact is also presented.

Note:  You must enable the KF_SA_OPTIMIZATION_ENABLE conguration seing and add the autotuner
component to your list of items for the Conguration buon. See Edit a Conguration Seing and Create a
Navigation Set for the Administrator.

Add SmartAssistant Suggested Answers  
Follow this procedure to add SmartAssistant suggested answers to a response.

1. Click SmartAssistant on the Messages tab toolbar.
A list of possible answers displays with columns for ID, Summary, Weight, Access, and Status. You can sort by
any of the columns.

2. To include the text of an answer in the response, click Add As Text in the Action column.
The answer content is added to the response.

Tip:  You can also enter answer text if you know an answer ID by pressing F9 from the incident
response on the Messages tab, entering the Answer ID number in the Append Answer Text window
that opens, and pressing Enter. You can edit the answer text before sending the response.

3. To add an answer URL link to the response, click Add As Link in the Action column.
4. To view a suggested answer, click View in the Action column.

The View Answer window opens, displaying the answer as it appears on the customer portal. (You can print the
answer from this view by clicking the File menu item and selecting Print.)

5. Click Close.

Mark an Answer as the Best Answer  
Mark an answer as the best answer to have SmartAssistant give it greater deference.

1. From the open incident, click Best Answers.
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A list of answers that have been added and commied to the incident thread is displayed with columns for ID,
Summary, Access Level, Status, and Date Added. You can sort by any of the columns.

2. To choose the best answer (or answers) for the customer’s question, select the Best Answer check box.
3. To clear all best answer selections, select the No Answer Resolved This Incident check box.
4. Click Save.

Review and Accept Autotuner Recommendations  
Review and accept SmartAssistant Auto Tuner seings.

1. Click Conguration on the navigation pane.
2. Double-click SA Auto Tuner component in your conguration list.

The SA Auto Tuner dashboard displays information regarding the current SmartAssistant conguration
seings, relevance history, and recommendations.

The dashboard contains the following reports.

◦ SA Conguration—This report contains information about your current SmartAssistant conguration
values (in the Current column) and the suggested values for optimizing them (in the Tuned column). The
Relevancy row displays the current aggregated relevancy value of SmartAssistant results.

◦ SA Relevance History—This report displays the percentage of answers suggested by SmartAssistant
that have been relevant over recent weekly intervals, also indicating when changes were made to
SmartAssistant seings. This demonstrates how changes you have applied impact the SmartAssistant
eectiveness of your site.

◦ Recommendations—This panel displays the current recommendation of the auto tuner (whether to
accept the suggested conguration changes) based on whether sucient SmartAssistant coverage was
available to evaluate and whether the recommendation is made with high, medium, or low condence.

3. To accept the suggested conguration and update your seings with the recommended values, click Accept
New Conguration.

How You Search the Knowledge Base  
As you respond to a customer’s question, you might remember answers that address similar issues. Rather than
conducting a time-consuming hunt of the knowledge base to nd the relevant answers, Service lets you search for
specic answers.

Using any of four text searching techniques, you can quickly identify answers to resolve a customer’s question. See
Append Answer Content.

Insert Standard Text from the Standard Text Window  
When you are busy responding to customer questions, you will appreciate having the routine parts of your job
streamlined as much as possible.
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For example, you would probably welcome a shortcut as an alternative to entering a standard greeting and closing for
every email response you send. Your administrator can create standard text for routine situations so you can insert a
text item into a response.

You can insert standard text from the Standard Text window or, if you know the keyboard shortcut for the text item, you
can enter it without opening the Standard Text window.

1. In your response, position the cursor where you want to insert the standard text.
2. Click Standard Text on the Messages tab toolbar.

The Standard Text window opens.
3. Do one of the following:

◦ Double-click the standard text item to automatically insert the text into your response.

◦ Select the standard text item you want to insert in your response and click OK.

◦ Drag the standard text item from the list into the response.

◦ Copy the text in the Preview section and paste it into the response.

If an HTML version of the standard text is available, it displays by default in the Preview section of the window.
Otherwise, the plain text version displays.

Tip:  To search for standard text, click Find in List.

4. Click OK.
5. To add other standard text items to the response, repeat these steps.
6. To modify the standard text, edit as necessary in the response.

Note:  If the standard text includes one or more variables, the variable is displayed in your response
rather than the value of the variable (the contact’s rst name in the example). The variable is replaced
with the data only when you send your response. Then, when you reopen the incident, the data
appears where the variable had been inserted.

Related Topics
• Add or Edit Standard Text

• Insert Standard Text Using a Keyboard Shortcut

• Add or Edit a Variable

Insert Standard Text Using a Keyboard Shortcut  
If you know the keyboard shortcut for standard text you want to insert, you can enter it without opening the Standard
Text window.

1. To display the keyboard shortcut for a standard text item, select the standard text in the column that contains
the Standard Text options in the Standard Text window.
The keyboard shortcuts are displayed in the Hotkey eld in the right column.

2. At the location in the incident response where you want to insert the standard text:
a. Press F8 to open a Standard Text eld.
b. Enter the keyboard shortcut in the eld.
c. Press F8 or Enter to insert the text into your response.

Related Topics
• Add or Edit Standard Text

982



Oracle Service Cloud
Using Service Cloud

Chapter 5
Service

Find Answers Using Guided Assistance  
Guided assistance is a powerful tool designed to step you through a series of questions and direct you to answers and
text responses you can oer your customers.

As you work with customers on the phone or respond to incidents, you can quickly nd the information that best helps
your customers. Guided assistance steers you to the information based on your answers to the questions rather than
you having to review SmartAssistant answers or search the knowledge base.

Before you can use guided assistance to work with incidents, your administrator must have enabled the tool on your
site, created guides for you to use, and added the Guided Assistance control to the incident workspace you use.

Buon Description

Expand Navigator Select this check box to open a panel on the left that displays all the branches used in the guide.

Navigate Click this buon after selecting a question or response on the left panel. The contents of the question
or response are displayed on the right panel.

Search for a Guide Click this buon to search for a guide.

Select a Guide Click this buon to select a guide.

Add Text to Thread Click this buon to add the text of the current question and response to the incident thread.

1. Open the incident for which you want to use guided assistance.
2. To select a guide from a list, click Guided Assistance  and click Select.

The Select a Guide window opens.
3. Select the guide you want from the list.
4. Click OK.

The Guided Assistance window opens.
5. To search for a guide, click Search for a Guide. The Search for a Guide window opens.

Note:  Before searching for a guide, you should ll out the associated incident’s product and category.
Only guides that have been associated with an answer can be searched.

a. Dene search terms by selecting drop-down menu options or entering phrases in a text eld.
b. Click Search.

A list of guides that match your search criteria displays.
c. Select the guide you want to use and click Select.

The window closes and the questions in the guide are displayed.
6. Answer each of the questions that are presented in the guide until you reach an end point, which is in the form

of a knowledge base answer or a text explanation.
7. If the results provide answers from the knowledge base, you can add a link to an answer or the text of the

answer in the incident thread, or you can view an answer.
a. To add a hyperlink to the answer in the incident, click Add as Link.
b. To add the text of the answer to the incident, click Add as Text.
c. To view the answer, click View.

8. Click Close.

Related Topics
• Overview of Guided Assistance
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Add or Edit Contact Information  
Because Service creates incidents from customer questions, the contact information is usually present when you
respond to an incident. Sometimes, however, you will need to add or edit contact information.

You can add multiple contacts to an incident, but you must designate only one as the primary contact. Secondary
contacts do not have to be associated with the same organization as the primary contact.

1. From an open incident, click the Contacts tab.
Information for the primary contact (which includes name, email address, phone, title, and address) displays at
the top of the tab, and nested tabs contain additional information.

2. To remove a contact from the incident, select the radio buon next to the contact’s name, click Remove, and
conrm that you want to remove the contact.
The contact is disassociated from the incident, but the contact’s record remains in the knowledge base.

3. To add a contact, do one of the following:

◦ To add a new contact to the incident, click Add New. A new contact opens on a subtab.

◦ To add an existing contact to the incident, click Add Existing, search for the contact you want to add, and
select it. To edit this contact, right-click it and select Open.

Note:  Adding a new contact from the Contacts tab does not change the primary contact for the
incident. To designate a primary contact, manually select Primary next to the contact’s name.
However, adding a new contact using Search next to the Contact eld of the incident not only replaces
the existing primary contact with the new contact, but the existing primary contact is automatically
removed from the incident.

4. To edit an existing contact for the incident, right-click the contact and select Open.
The contact opens on a subtab.

5. Add or edit contact information in the First Name and Last Name elds and make a selection in the State eld.
6. To add or edit other contact information, make the changes in the elds or on the record tabs.
7. Click OK.

The Contact subtab closes and keeps the contact data in memory. The contact record is not saved in the
knowledge base until you save the incident.

8. To add other information to the primary contact record, click the Contact Fields subtab.
a. To add or edit the contact’s login, enter it in the eld.
b. To select or change the contact’s global opt-in choice, email format, or state, click the appropriate drop-

down menu and select an option.
9. To view incident information for the primary contact, click the Incident History subtab.

10. Click Save.

Related Topics
• Overview of Contacts

• Edit Key Incident Fields

Add Time Billed to an Incident  
This topic describes how you can use the elds available on the Time Billed tab to track your time working on an
incident.

Your organization may collect statistics on the amount of time agents spend solving incidents so that management can
plan for beer use of sta time. These statistics can also identify products or issues that are causing similar customer
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questions, allowing answers to be added to the knowledge base to reduce the amount of time agents must spend on
them.

The Time Billed tab is where you enter the amount of time you spend on an incident. It also lets you see details about
the amount of time other agents spent on the incident. Depending on how your administrator has congured your
application, you may be required to enter time billed every time you edit an incident or before you can set an incident
status to Solved.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Click the Time Billed tab. The tab contains the number of time billed entries associated with the incident in

parentheses next to the tab name.
3. Click Add New to open the Time Billed window.

4. Enter eld information.

Field Description

*Date The default is today’s date. Click the drop-down menu to open the current month’s
calendar and select a date.

*Billed By Click this drop-down menu and select a sta member. This eld defaults to your sta
account since you are editing the incident.

*Billable Task The default billable task is Miscellaneous, but your administrator may have added other
billable tasks for you to select. Click this drop-down menu and select a task.

*Duration Select the value in the Hours or Minutes eld, or both, and enter a new value. Or use the
up and down arrows to adjust the duration.

Notes Enter a note about the time billed for the incident.

5. Click OK.
6. Click Save.

Modify Time Billed Entries  
You can edit and delete time billed entries as necessary.

1. To edit a time billed entry, right-click it and select Open.
a. Make your changes.
b. Click Save.

2. To delete a time billed entry, right-click the entry and select Delete.

Note:  Deleting a time billed entry can result in inaccurate statistics in reports.

Add or Edit a Task for an Incident  
You can add and edit all tasks associated with an incident by clicking the Tasks tab.

When you add or edit a task, you not only dene its name, the sta member it is assigned to, relevant dates, and type of
task, but you also associate it with new or existing incidents. The tab contains the number of tasks associated with the
incident in parentheses next to the tab name.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Click the Tasks tab.
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3. Do one of the following:

◦ Click Add New to open the new task on a subtab. The reference number for the incident appears in the
Incident eld on the new task editor.

◦ Right-click a task on the Tasks tab and select Open.

4. Add or change the task name in the Name eld.
5. Click the Status drop-down menu and select a status for the task. The default status is Not Started.
6. To enter additional task information, complete the elds or select menu options.
7. Click OK.
8. Click Save.

Related Topics
• Overview of Tasks

Edit an Organization Associated with an Incident  
Incidents are associated with contacts. If an incident also has an organization association, it’s because the primary
contact is associated with an organization.

The Organization tab lets you view the name and ID of the organization associated with the primary contact, and
you can edit the address, login, password, and state for the organization. But if you want to change the organization
associated with an incident, you will have to edit the contact record.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Click the Organization tab.

Note:  The Organization Name and Organization ID elds are read-only.

3. To enter an address, click Edit in the lower right corner of the Billing eld to display a window for entering the
address. Enter information in the Street, City, and Postal Code elds, and make selections on the Country and
State/Prov elds drop-down menus. When you select the country, the associated states or provinces appear
in the State/Prov menu. Press Enter when you are nished to close the window and display the address you
entered.

4. To enter a login or password, enter the information in the appropriate eld.
5. To change the state, click the drop-down menu and select an option.
6. To view the incident history for the organization, click the Incident History tab.
7. To view the contacts, click the Contacts for Org tab. You can also open, add, print, copy, assign, delete, and

email contacts using the toolbar on this tab.

CAUTION:  There are usually consequences when a contact is deleted. See Delete a Contact.

8. Click Save.

View Web Visit Information for an Incident  
You might nd it helpful to know what information contacts viewed on the customer portal before they submied their
question.

On the Web Visit tab of an incident, you can see what questions they viewed and any searches they performed. In
addition, the customer’s referring site (the site they were visiting prior to accessing the customer portal), source IP
address, operating system, and browser information are provided.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Click the Web Visit tab.
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The number of actions are listed in parentheses on the tab.

Incident Aachments Tab  
The Aachments tab lets you add les containing information that may not t neatly into an incident.

For example, you might want to aach a le that contains graphic elements. When you aach a le to an incident or
incident response, that le becomes permanently aached to the incident. Likewise, any le the customer aaches
when submiing a question also becomes permanently aached to the incident. HTML email updates that are larger
than the maximum description size are aached to the incident as an HTML le.

The Aachments tab lists all les aached to the incident and contains the le name, size, dates created and updated,
a description, and whether the aachment is private (not visible on the customer portal). You and other sta members
can access any aached le from the Aachments tab of the incident, while the customer can access it from the Your
Account page on the customer portal.

If a le is aached at the same time an incident thread is added on the Messages tab, an Aachments indicator displays
in the title bar of the thread on the Messages tab after the incident is saved. Click the Aachments drop-down menu to
display aachments added at the time the thread entry was saved, then click a le name to view the le.

Note:  The Aachments indicator drop-down menu in a thread title bar indicates which les were sent in your
response to the customer and helps you identify the point in the incident thread an aachment was added to
the incident. If you aach a le and save the incident when there are no uncommied threads, the aached le
will appear on the Aachments tab but not on the Messages tab.

Files that are permanently aached to an incident are not sent in your response to the customer unless you specically
mark them to be sent with the response. This lets the customer open the le directly from the email client instead of
having to log in to view it.

Related Topics
• Overview of the Aachments Tab

• How Mailboxes Work

• Aach Files to an Incident Response

Present an Oer  
In your role as an agent, your organization may ask you to present special oers to customers because you have a
strong understanding of what they need and have earned their trust through your work with them.

When you work with an incident, Service evaluates the customer’s information and purchase history. Based on the
results, it looks for oers the customer is eligible for. These oers can include promotions, suggestions, or both.
Promotions are special oers made to specic groups of customers (called targets), while suggestions are automatically
generated based on customer information. An example of a promotion is free shipping on certain products. An example
of a suggestion is oering a headset to someone who has recently purchased a cell phone. When the customer is
eligible for an oer, the Oer Advisor buon is enabled. After you nish responding to the customer’s question, you can
click Oer Advisor to display an Oers window.

The following procedure is a brief overview of presenting an oer to a customer. For the complete procedure, see How
You Present Oers.

1. From an open incident, click Oer Advisor to open the Oer Advisor window.
2. Select the oer you want to present to the customer.
3. Do one of the following:
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◦ If you are on a phone call with the customer, read or paraphrase the guide and product information to the
customer.

◦ Or, if you are responding to an incident, right-click anywhere in the guide text or product information
sections and select Copy. Paste the text into the response and modify as necessary before sending.

4. Click Set Response in the Action column for the oer you want to present.
The associated drop-down menu in the Response column is activated.

5. Click the drop-down menu and select Yes, Interest, No, or Defer.
6. Click OK.
7. Click Save.

Create an Opportunity from an Incident  
During the course of working with customers, you might discover information that makes them potential customers for
other services and products your organization oers. In those cases, you can create opportunities and send them to the
sales department for evaluation and follow-up.

The workspace you use to create an opportunity from an incident may be dierent depending on your prole and any
custom workspaces dened by your administrator.

1. From an open incident, click New Opportunity.
2. To edit any information for the opportunity, enter the eld information described in Edit Key Opportunity Fields.
3. Click Save.

How You Send Incident Responses  
When you have completed a response to an incident, you are ready to send your reply to the customer. Several options
are available when you send a response, including aaching les to the response, copying other recipients, and
selecting encryption options.

The behavior for sending responses depends on the seings your administrator selected when creating the incident
workspace for your prole. The standard incident workspace behaves in the following manner when you add a
Response type thread entry to the uncommied threads panel.

• The Send on Save check box is cleared, so you must select it if you want to automatically send your response
to the primary contact when you save the incident. For this reason, you might not want to select it until you
have nalized your response so you do not send a response each time you save changes while you work on the
incident.

• If an uncommied response thread exists and the Send on Save check box is selected, the Email title bar
displays an aachment icon for associating aachments and a CC eld for notifying other contacts. BCC and
sign/encrypt functionality can be enabled on the Options window (accessed by clicking Options on the thread
control, which is typically found on the Messages tab toolbar).

• You can save a draft response to an incident without sending it. Click Options on the thread control and select
the Always Show for Responses check box below the Email Message Header. You will then be able to set CC,
BCC, and aachments for a response, and save that data until you want to send the response. See Aach Files
to an Incident Response and Select Additional Recipients for an Incident Response.

• Customer-entered URLs are replaced with [link removed] in response emails. This ensures that customer-
entered URLs (IP addresses) are not identied as spam and blocked. This functionality can be overridden by
populating the EGW_ALLOWED_DOMAIN_NAMES and EGW_ALLOWED_TOP_LEVEL_DOMAINS conguration
seings located in RightNow Common/Service Modules/RightNow Email. See How You Customize
Conguration Seings.

• If a contact is associated with multiple email addresses, service responses are sent to all associated addresses
by default. You can limit your responses to be sent to a single email address by enabling the site-wide
conguration seing OE_SVC_SENDMAIL_SINGLE_ADDRESS (Common/General/Outgoing Email). See How
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You Customize Conguration Seings. When enabled, service responses are sent only to the specied email
address and agents can select which one of the contact email addresses they want to send the response to.
That email address value remains for the life of the incident. However, any new incidents for that contact will
default to the primary email address.

Send a Response to the Primary Contact  
Follow this procedure to send a response to the primary incident contact.

1. Do one of the following:

◦ Click Send.

◦ Select the Send on Save check box, and then click Save or Save and Close.

If a customer does not receive your response, a Viewed Bounced Messages buon appears on the Response
title bar in the commied threads panel. See View a Bounced Message.

Send a Single Response to a Contact Associated with Multiple Addresses  
Follow this procedure to send a single response to a contact associated with multiple addresses.

This procedure assumes you have enabled the site-wide conguration seing OE_SVC_SENDMAIL_SINGLE_ADDRESS
(Common/General/Outgoing Email). See How You Customize Conguration Seings.

1. Select the Send on Save check box.
The Response title bar expands and displays the primary contact’s email address, an Aach buon (paperclip
icon), and a CC eld.

2. Click the drop-down menu to the right of the primary contact’s email address and select the address to which
you want to send the response.

Note:  This email address value remains for the life of the incident. However, any new incidents for this
contact will default to the primary email address.

3. Click Save.

Related Topics
• Aach Files to an Incident Response

• Select Additional Recipients for an Incident Response

Aach Files to an Incident Response  
Follow this procedure to aach les to an incident response.

1. Click Options and select the Always Show for Response check box below Email Message Header.
The Response title bar expands and the Aach buon displays.

2. Click Aach.
The Aachments window opens.

3. To send the response with one or more les that have been aached to the incident, select the associated check
boxes in the Incident Files section of the Aachments window.

4. To aach additional les to the incident response, click Add Files and select Browse to view the les and
folders on your workstation. Or select Search to open the File Search window.

a. If you selected Browse, select the le and click Open to aach it to the response.
b. If you selected Search, specify a directory, all or part of a le name, and the type of le. Click Search.

Then select one or more of the matching les and click Add Files.
5. Click OK.
6. Click Send.
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The response is sent with aachments to the customer, as well as any other recipients you added to the CC or
BCC elds. Aached les sent with the response will appear in the Aachments drop-down menu in the title bar
of the response.

Note:  All les aached to an incident or incident response are recorded in the knowledge base and
audit log. Files aached to an incident using the Aachments tab, rather than with the Aachments
buon in the response title bar, are stored with the incident, but are not sent with the response unless
selected. These les appear in the Aachments drop-down menu in the title bar of the message with
the heading “Added to incident, but not sent.” See Incident Aachments Tab.

Select Additional Recipients for an Incident Response  
Follow this procedure to select additional recipients for an incident response.

1. Click Options and select the Always Show for Response and Show CC check boxes under Email Message
Header.
The Response title bar expands and the CC eld displays. To display the BCC eld, you must also select the
Show BCC check box on the Options window.

2. Click CC.
The Select Names window opens.

3. To import your contacts from the default Contacts folder in Outlook, select the Load Outlook Contacts check
box. This is useful for displaying contacts that are not included in Oracle Service Cloud.

4. Select a name from the list.

Tip:  You can enter the rst few leers of the name in the eld at the top of the Select Names window.
The rst name in the list that matches the leers you typed is highlighted. Notice that this name may
be the contact’s rst or last name, an email address, or a group or distribution list.

5. Click CC to list the name in the CC eld or click BCC to list the name in the BCC eld. Names or addresses in the
CC eld are visible to all recipients of the response. Names in the BCC eld are not visible to other recipients.

6. Click OK.
7. Click Send.

The response is sent to the customer, as well as any other recipients you added to the CC or BCC elds.

Depending on how your administrator congured your application, the incident status may change to Solved when you
save the incident. The incident assignment may also change to your name if the incident was previously assigned to
another sta member.

Sign and Encrypt an Incident Response  
Follow this procedure to sign and encrypt an incident response.

1. Click Options and select the Always Show for Response and Show Sign/Encrypt check boxes below Email
Message Header.

Note:  Because dierent sta members can be working on the same incident, email signatures are
appended to the thread that you are responding to instead of to the boom of the email. If your email
signature does not populate the thread response, your administrator has not set up email signature
information. Contact your administrator for more information.

2. Select the Sign check box.
You cannot select the Sign check box if the Service mailbox does not have a certicate that allows sending
encrypted email.

3. To encrypt your response to the contact, click the Do Not Encrypt drop-down menu and select Encrypt When
Possible or Encrypt Always.
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You cannot select an encryption option if the contact you are responding to does not have a certicate that
allows receiving encrypted email. If you select Encrypt Always, you can select only addresses that have
certicates associated with them.

Related Topics
• How SMIME Security Works

View a Bounced Message  
If a customer does not receive your response due to a bounced message, a View Bounced Message buon displays on
the Response title bar.

The audit log will also contain an entry for the bounced incident response that reads, “From Techmail–Incoming Auto-
Reply Message.”

1. Click View Bounced Messages on the Response title bar.
The Bounced Messages window opens, displaying full text copies of each bounced email.

2. Click OK.

Service Collaboration  
Service Collaboration lets agents collaborate with other agents to more quickly resolve customer questions.

From the incident workspace, agents can create conversations containing the details of their ndings and post
questions to other agents. The ability to collaborate with other agents encourages knowledge sharing among your sta
and decreases response time to customers.

Note:  To enable and congure Service Collaboration, see  Answer ID 6902  on our support site.

After Service Collaboration is enabled, you will need to:

• Assign sta members permission to use collaboration

• Create a custom incident workspace to include a collaboration relationship item control

• Add the My Incident Conversations item to the navigation set of agents with collaboration permission. Adding
this item lets agents quick access to all conversations in which they are participating.

Oracle Social Network (OSN) can be integrated with the agent desktop using Service Collaboration. Agents can
customize their toast preferences for OSN notications. For the link to the OSN documentation, see Oracle Social
Network.

Related Topics
• Custom Workspaces

• Workspace and Script Controls

• Service Permissions

Congure Collaboration with External Users  
This topic describes how to congure a prole for an external user to assist agents in solving customer questions.

Service Collaboration lets agents get assistance from other sta members who are not agent desktop users. These
external users, such as engineers, product experts, analysts, and other subject-maer experts (SMEs), can be brought
together to answer complex questions or contribute to solving an incident.
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You can create a prole specically for external users. Users with this prole will be able to log in to the collaboration
service directly using a web browser or supported mobile device, but will not be able to use the Service Console. You are
permied up to 100 external users for each Service Console license.

1. Create a prole that will be used only for external users.
2. On the Other tab of the Proles editor, select the External User check box.

Note:  Collaboration must be enabled for the External User check box to be visible.

3. Save and close the new prole.
4. Create sta accounts for the external users, and assign the external user prole to them.
5. On the Sta Accounts editor, select Disabled from Assignment/Report Filters from the Disabled drop-down

menu for each external user sta account.

Related Topics
• Proles

• Add or Edit a Sta Account

Cobrowse with a Customer from an Incident Workspace  
This topic describes how to use Cobrowse to assist a customer while working on an incident.

With Cobrowse, you can guide a customer through a web page using your mouse or other pointing device to
demonstrate actions. In eect, you take control of the customer’s web browser to show the customer how to complete
an action. Cobrowse helps eliminate the confusion that can arise when giving verbal instructions and is eective for
assisting customers in lling out forms or completing a sale.

Note:  Cobrowse must be enabled before you can begin a session with a customer. In addition, you can
engage in only one cobrowse session at a time.

1. While speaking with a customer on the telephone, direct the customer to the location of the cobrowse link
on your customer portal and instruct the customer to click it. A message notication opens and provides the
customer with an access code number.

2. With the customer’s incident open, click the Cobrowse tab.
The cobrowse login page displays and your Oracle Service Cloud login name appears in the Agent Name eld.

3. Ask the customer for the secure session ID number and enter it in the Access Code eld.
4. Click Connect. The cobrowse toolbar displays and the cobrowse session begins.

Your viewing and cobrowsing options are limited depending on how your company has set up the Cobrowse
deployment. Privacy seings can dier when you cobrowse in Instant Cobrowse mode or Advanced Cobrowse
mode. Your company’s Cobrowse administrator congures the privacy seings.

Buon/Field Description

Mode Click this drop-down menu to select an advanced cobrowse state, which species how
much control you have over the customer’s desktop.

View Only Select to view the customer’s active window. This option is selected by default in
Advanced Cobrowse mode.
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Buon/Field Description

View + Pointer Select to view the customer’s active window and use a labeled mouse as a pointing
device on the customer’s screen.
With this option selected, mouse-click functionality does not work on the customer’s
active window. This option is selected by default in Instant Cobrowse mode.
 

View + True Pointer Select to view the customer’s active window and control the movement of the
customer’s mouse or other pointing device.
This option is only available when cobrowsing in Advanced Cobrowse mode. With this
option selected, mouse-click functionality does not work on the customer’s desktop.
 

Full Control Select to view the customer’s active window, control all mouse or other pointing device
functions (pointer and mouse clicks), navigate to other company web pages, and use
your keyboard to enter information on the customer’s active window (for instance, to
help the customer ll out a form). The customer receives a consent message to permit
or deny full control.
In Advanced Cobrowse mode, you can access the customer’s desktop and cobrowse
third party sites.
 

Advanced Mode Select to escalate to the Advanced Cobrowse mode. An invitation is sent to the customer
to activate Advanced Cobrowse mode.

Client Info Displays the customer’s environment information for operating system, browser version,
 client version, and escalation mode.

Disconnect Click this buon to end the cobrowse session.

Connection Quality Information Displays the strength of the connection in a bar graph.

Zoom In Click to zoom in on the customer’s desktop.
This buon is available only in Advanced Cobrowse mode.
 

Zoom Out Click to zoom out on the customer’s desktop.
This buon is available only in Advanced Cobrowse mode.
 

5. Click Disconnect to end the cobrowse session. Both you and the customer are notied when the cobrowse
session ends. The customer can also disconnect from the cobrowse session at any time.

Note:  Although cobrowse information is not recorded to the incident transcript, it is recorded to the
knowledge base and can be viewed using standard cobrowse reports.

Related Topics
• Overview of Cobrowse
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Add an Incident  
This procedure describes how to add an incident for a customer using Oracle Service Cloud.

Incidents are generally submied by customers from the Ask a Question page or through email. As a result, the majority
of your time is probably spent editing incidents. However, Service does not automatically create incidents when
customers contact you by phone, mail, or fax, so you may nd yourself adding incidents from time to time.
When you add an incident, you create a record of both the customer’s question and your response, which can help your
organization track resolution of the incident. You can add incidents to your knowledge base no maer what navigation
list is active or what kind of record you are working on.

1. Do one of the following:

◦ Click New on the ribbon.

◦ If your navigation set is congured to add incidents from the le menu, click  File > Incident .

Note:  Notice that the Reference # and Organization Name are read-only elds. The reference number
is automatically assigned by Oracle Service Cloud, and the organization name (if the eld contains an
entry) is the one associated with the primary contact for the incident.

2. Enter the question or issue in the Subject eld, to a maximum of 240 characters.
3. Complete the incident elds as described in Edit Key Incident Fields.
4. Click the Customer Entry eld and enter the customer’s question.
5. Click  Add > Response .
6. Enter your response. See Incident Thread and Response Options.
7. To add or edit contact information for the incident, click the Contacts tab and complete the information as

described in Add or Edit Contact Information.
8. To enter the time you spend working on the incident, click the Time Billed tab and complete the information as

described in Add Time Billed to an Incident.
9. To add or edit task information for the incident, click the Tasks tab and complete the information as described

in Add or Edit a Task for an Incident.
10. To add or edit organization information for the incident, click the Organization tab and complete the

information as described in Edit an Organization Associated with an Incident.
11. To aach one or more les to the incident, click the Aachments tab. See Overview of the Aachments Tab.
12. To present an oer to the customer, click Oer Advisor. See Present an Oer.
13. To create an opportunity from the incident, click New Service Opportunity. See Create an Opportunity from an

Incident.
14. To send a response, see How You Send Incident Responses.
15. Click Save.

Related Topics
• Incident Management

• Create an Incident (video)

Incident Management  
Besides editing and adding incidents, you may have other incident management duties as well. For example, you might
want to propose that incidents be added as answers to the knowledge base, delete incidents, or requeue or reassign
incidents.

For other incident management tasks, including forwarding incidents and updating multiple incidents simultaneously,
see Overview of Common Functionality.
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Propose an Answer from an Incident  
You can propose an incident to become a potential answer for your knowledge base.

Sometimes a customer’s question is common enough that you believe other customers should also have access to
the answer. If you believe this information belongs in the knowledge base, you can propose the incident as a potential
answer that customers can view without needing to submit a service request. This helps the knowledge base stay
current with the information customers need.

When you propose an incident as an answer, a copy of the incident is submied to a knowledge engineer, who
determines whether it should become an answer. If it should, the knowledge engineer rst denes an answer access
level, answer status, language, and visibility, and then publishes the answer.

Note:  Incident custom elds may or may not be included when you propose an incident as an answer. If you
propose an incident from an incidents report, by either right-clicking the incident and selecting Propose or
by clicking Propose on the report ribbon, the incident custom elds are not added to the Notes tab on the
Propose Incident for Answer window. If, however, you click Propose from an open incident, the custom elds
do appear on the Propose Incident for Answer window.

1. Do one of the following:

◦ From an incidents report, right-click the incident and select Propose Incident.

◦ With the incident open, click Propose.

The Propose Incident for Answer window opens.
2. Review the proposed answer and make any necessary edits.
3. To add a note to the proposed answer, click the Notes eld and enter your comments.
4. To add or remove any products or categories associated with the proposed answer, click the Products and/or

Categories tab. Select those you want to associate with the proposed answer, and clear those you do not want
to associate with the answer.
The products and categories associated with the incident are selected by default.

5. To remove any les that are permanently aached to the incident from the proposed answer, click the Files tab.
Clear the check box next to any le you do not want to propose with the incident.
All les permanently aached to the incident are selected to be proposed with the incident by default.

6. Click OK.
A conrmation message lets you know that an answer was proposed from the incident.

Related Topics
• How You Add Answers for Multiple Interfaces

Delete an Incident  
If your prole gives you permission to delete incidents, the Delete buon is enabled on the ribbon. When you delete an
incident, you permanently remove it from the knowledge base.

1. Do one of the following:

◦ To delete an incident when the incident is open, press Delete. A message asks you to conrm deletion of
the incident.

◦ To delete an incident from an incidents report, right-click the incident and select  Delete > Incident .

2. Click Yes.
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Note:  Sta members with the Bulk Delete permission enabled can delete up to 1000 incident records
at a time. See Administration Permissions and Bulk Delete.Transactions associated with those incidents
are deleted asynchronously. Purging transactions is controlled by data lifecycle management policies.
See Data Lifecycle Management.

Reassign or Requeue an Incident  
You might need to assign incidents from your inbox to another sta member or move them back into an incident queue.

These situations commonly require you to move incidents, although your manager may have other guidelines as well.

• You log out for the day—To avoid having unresolved incidents siing in your inbox when you leave for the day,
you might want to assign them to another sta member or place them back in a queue.

• You are assigned an incident you should not have received—When an incident is incorrectly assigned, you can
assign it to another agent or group or move it to the correct queue.

1. From an incidents report, right-click the incident and select  Open > Incident .
2. Do one of the following:

◦ To reassign the incident, click the Assigned drop-down menu and select the appropriate group or sta
member.

◦ To requeue the incident, click the Details tab, click the Queue drop-down menu, and select the
appropriate queue.

3. Click Save.
The incident is moved from your inbox to the agent inbox or selected queue.

Archived Incidents  
As customers submit incidents and sta members create incidents, which might have aachments and responses, your
site’s database can grow very large, leading to performance issues.

To avoid these issues, Oracle Service Cloud archives incidents automatically past a certain period of time after they are
solved. Archived incidents can also automatically be purged (deleted permanently).

You can access data lifecycle management on the Agent Browser UI, which provides built-in policies to archive and
purge unused or unrequired data automatically and periodically. See Data Lifecycle Management.

Open the Archived Incidents Component  
There might be times when you need to reference outdated incidents to beer serve your customers. In Oracle Service
Cloud, you can search for and view incidents that have been removed from your knowledge base and archived.

Before you can access the Archived Incidents component, the appropriate permissions must be dened in your prole.
Customize navigation sets must be enabled, in addition to Incident Read permission. You must then add the Archived
Incidents component to a navigation list. Contact your administrator if you are unsure of your permissions or this
component’s location.

Note:  Archived incident information is read-only and cannot be updated. In addition, you must perform a
search to display and view archived incidents.

1. Click the navigation buon that contains the Archived Incidents component.
2. Double-click Archived Incidents. The Archived Incidents component opens on the content pane.

You can search for, view, print, and export incidents. No incidents display until you perform a search.
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In addition to a basic search function, the Archived Incidents component features advanced searching
capabilities for retrieving archived incidents based on a broad range of search elds, including the subject,
threads, product, category, disposition, contact data, and organization data associated with the incident. You
can search ranges for incident creation and closed dates. Custom elds of a string or date data type can also be
searched using a specially formaed search value.

After you perform a search, the archived incidents that match your search criteria display on the content
pane. Search results are limited to 1,000 incidents rendered in groups of 100. Pagination controls appear when
search results exceed 100 incidents. Search results list the reference number, subject, creation date, and closed
(solved) date for each incident. To view an incident returned in the search results, double-click an archived
incident to open it, or select the incident and click View Incident.

Note:  Oracle Service Cloud workspaces do not apply to archived incidents. Therefore, the layout of
archived incidents and the location of certain elds are dierent from the way incidents normally
display on the Service Console. If an incident includes HTML formaing when it is archived, the HTML
formaing is retained and displays on the content pane.

Sidebar/Tab Description

Incident sidebar Displays the incident reference number, the sta member and queue the incident was
last assigned to, the interface name, and any other information that applies to the
incident such as product, category, and disposition.

Messages Displays the incident thread.

Details Displays the source of the incident and any custom elds associated with the incident.

Audit Log Displays the history of all actions taken on the incident by the incident originator and
other sta members. Also included is the date of each action.

Organization Displays organization information, including the organization name, total revenue
currency, source level, and CX state.

Contact Displays the contact’s information, including name, email address, login, date created,
 and date updated.

Perform a Basic Search for an Archived Incident  
You can search for an archived incidents. No incidents display until you perform a search.

1. Click Search on the Archived Incidents component.
The Search window opens.

2. Enter search terms.

Field/Buon Description

Reference Number Enter the reference number of the incident in this text box.

Text Search Enter a word or phrase in this text box to search all archived incident elds. Because
archived incidents have been removed from the knowledge base and converted to a text
format, you can only search for incidents with a single text search. Searchable incident
elds include Subject, Incident thread, Product (including subproducts), Category
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Field/Buon Description

(including subcategories), contact-related elds, organization-related elds, incident
custom elds, and incident custom aributes.
A Boolean OR operator is used between words by default. In addition, there is an implicit
wildcard at the end of the search string.
 

Advanced Search Click this link to access Advanced Search options.

Order By Click this drop-down menu to select a sort order.

3. Click Search.

Related Topics
• Perform an Advanced Search for an Archived Incident

Perform an Advanced Search for an Archived Incident  
The Archived Incidents component features advanced searching capabilities for retrieving archived incidents based
on a broad range of search elds, including the subject, threads, product, category, disposition, contact data, and
organization data associated with the incident.

You can search ranges for incident creation and closed dates. Custom elds of a string or date data type can also be
searched using a specially formaed search value.

1. Click Search on the Archived Incidents component.
The Search window opens.

2. Click the Advanced Search link to access advanced searching options.

Note:  To return to basic search options, click the Basic Search link in the top left corner of the window
and see Perform a Basic Search for an Archived Incident.

3. Enter eld information.

Field/Buon Description

Search Aributes (contains) Search results contain all or part of the search terms.

Ref Number Enter all or part of the reference number of the incident in this text box. You can use
wildcards in searching.

Text Search Enter a word or phrase in this text box to search all archived incident elds. Because
archived incidents have been removed from the knowledge base and converted to a text
format, you can only search for incidents with a single text search. Searchable incident
elds include Subject, Incident thread, Product (including subproducts), Category
(including subcategories), contact-related elds, organization-related elds, incident
custom elds, and incident custom aributes.
A Boolean OR operator is used between words by default. In addition, there is an implicit
wildcard at the end of the search string.
 

Subject Enter a word or phrase in this text box to search the Subject eld of archived incidents.
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Field/Buon Description

Threads Enter a word or phrase in this text box to search the thread content of archived
incidents.

Filter Aributes (exact match) Search results match the search terms exactly.

Product Use this text box to search the Product eld of archived incidents.

Category Use this text box to search the Category eld of archived incidents.

Disposition Use this text box to search the Disposition eld of archived incidents.

Queue Use this text box to search the Queue eld of archived incidents.

Interface Use this text box to search the Interface eld of archived incidents.

Customer Search for specic customer information including the contact name and contact email.

Contact Name Use this text box to search contact names in archived incidents.

Contact Email Use this text box to search contact email addresses in archived incidents.

State/Province Use this text box to search contact states or provinces in archived incidents.

Country Use this text box to search contact countries in archived incidents.

Organization Search for specic organization information including the name, state/province, and
country.

Name Use this text box to search organization names in archived incidents.

State/Province Use this text box to search organization states or provinces in archived incidents.

Country Use this text box to search organization countries in archived incidents.

Range Dene the date range search criteria using the closed date and created date.

Closed Date Click the From and To drop-down menus and select start and end dates to search
archived incidents by a closed date range.

Created Date Click the From and To drop-down menus and select start and end dates to search
archived incidents by a created date range.

Custom Fields/Aributes Search for specic information in custom elds and system aributes.

Custom Fields Enter a search string to search custom elds of a string, text, or date type in archived
incidents. The search string format is:

 <custom_field_name>_custom_<search_data_type>:

<search_term> [<connector> 
<custom_field_name>_custom_<search_data_type>:

<search_term>]

Where:
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Field/Buon Description

◦ custom_eld_name = name of the custom eld or aribute

◦ search_data_type = text, str, or date

◦ connector = AND or OR

◦ search_term = data to search for

Examples:
 

c$url_custom_str:”help.example.com”
 c$RMA_custom_text:RMA12345 AND 
CO$VarCharText_custom_str:megabyte
 c$date_custom_date:[20130326T11:37:00Z TO NOW]

Note:  Use quotation marks when searching for a URL value in a text eld. Use
YYYYMMDDTHH:MM:SSZ format for date/time values. You can join multiple
search strings together using the AND and OR operators.

4. To clear all eld search values, click Reset.
5. Click Search.

Note:  Multiple search terms will be joined with AND operators. For example, searching with 14* in the
Ref number eld and Phone in the Subject eld will nd only incidents that satisfy both criteria, that is,
their reference numbers start with 14 and their subjects include “Phone.”

Delete an Archived Incident  
You can delete a selective archived incident, permanently removing the incident from your organization’s database.

Your prole must have Administration permission before you can delete archived incidents. See Administration
Permissions.

There may be times when you want to delete an archived incident prior to the specied purge date dened by your
organization. This procedure lets you delete an archived incident, regardless of the period specied for archived
incidents to be automatically deleted.

1. Click Search on the Archived Incidents component.
The Search window opens.

2. Click the Advanced Search link to access advanced searching options.
3. Enter search terms as described in the Archived Incidents Advanced Search Options table.

Tip:  You can also use Basic Search to search for an archived incident.

4. Click Search.
The search results display on the Archived Incidents component.

5. Select the check box next to the incident(s) you want to permanently delete.
6. Click Delete.
7. Click OK in response to the conrm delete message.
8. Click OK in response to the selected incidents are being deleted message.

Note:  It may take up to 30 minutes for the deleted incidents to be fully removed from the database.
Deleted incidents may continue to display in search results until the delete operation is complete.
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Export Archived Incidents  
After performing a search, you can export archived incidents.

1. Select the archived incidents you wish to export. You can export up to 100 incidents at a time.
2. Click Export.
3. Select the location where you want to save the export le, enter a name for the le, and click Save.

The export le will be saved with a .zip extension, and will contain each exported incident as an individual XML le.
You can also open the export le, in which case it will be downloaded to a temporary folder rst, then opened.

Incident Thread Management  
In addition to the tools you have for answering customer questions and maintaining accurate records of all
communications with your customers, you also have tools that can help you protect customer information contained in
incident threads and, when necessary, convert information from response threads to note threads.

• Incident Thread Masking

• Edit or Convert a Response Thread

Incident Thread Masking  
Your customers and agents may occasionally submit incidents containing sensitive customer information, such as credit
card and social security numbers in incident threads. Whether the information appears in a customer entry, response, or
private note thread, the security of your customers’ personal assets may be compromised.

Incident thread masking can protect this personal data by automatically masking content in incident threads. By default,
Oracle Service Cloud contains three predened system masks for credit card, social security, and telephone numbers.
In addition, if our predened paerns do not satisfy your organization’s needs, you can dene up to ve custom masks
to hide other personally identiable information when new thread entries are created. As you congure incident thread
masking for your application, you can test each system and custom mask before nally deploying the congurations to
your site. To mask customer information in incident threads, incident thread masking must be enabled. Contact your
Oracle account manager to enable this feature.

CAUTION:  Be aware that after incident thread masking is enabled, masking is automatically performed in
new thread entries, even if you make no changes to the predened masks or dene custom masks. Masking
also occurs in the incident thread data itself, where the masked values are replaced and not recoverable.
Note that predened text, such as standard text, SmartAssistant responses, and variables, is not masked. Do
not include condential information in predened text. For these reasons, you should use extreme caution
when conguring masking for your site, and enable the prole permission for this feature only for trusted
administrators.

After incident thread masking is enabled, you must perform the following tasks so you and your sta can congure
incident thread masking.

• Add the Incident Thread Masking component to the Conguration buon in at least one navigation set. See
Create a Navigation Set for the Administrator.

• Assign the Administration permission on the Administration tab of proles so specic sta members can
congure incident thread masking. See Administration Permissions.
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Congure Incident Thread Masking  
By default, Oracle Service Cloud contains three predened system masks for credit card, social security, and telephone
numbers. In addition, if our predened paerns do not satisfy your organization’s needs, you can dene up to ve
custom masks to hide other personally identiable information when new thread entries are created.

1. Click Conguration on the navigation pane.
2. Double-click Incident Thread Masking in the conguration list.

The Incident Thread Masking editor opens on the content pane.
3. Enter eld information.

Field/Buon Description

System Masks
 

This section contains a list of three predened system masks, which are enabled by
default. In addition, the last four digits of each system mask also display by default. You
can edit each system mask to hide the last four digits or disable any system mask you
do not need.
 
When incident thread masking is enabled, masking is automatically performed on
credit card, social security, and telephone numbers entered in new incident threads with
no action required on your part. You can enable or disable these options to suit your
business needs.
 

Credit Card
 

Clear the Enabled check box to disable the credit card mask, or clear the Show Last 4
Digits check box to hide the last four digits of credit card numbers.
 
This mask matches major credit card numbers including Visa, MasterCard, Discover,
 American Express, and Diners Club. Hyphens, periods, and spaces are accepted as
dividers between number groups, as in the following examples. The dividers can be at
xed/random intervals.
 

Note:  Credit cards with 12–19 digits are supported by Incident Thread Masking
to include additional credit card types, not just those in the following list.

◦ Visa:

4215101992633023

4215 1019 9263 3023

453 939339 6455

453-939339 6455

◦ MasterCard:

5406209167573761

5406-2091-6757-3761

5406.2091.6757.3761

540.620916.757.3761

◦ American Express:
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373518140296377

3735 181402 96377

◦ Discover:

6011891400863425

6011.8914.0086.3425

601.189.140.086.3425

◦ Diners Club:

30139201272845

SSN
 

Clear the Enabled check box to disable the Social Security numbers mask, or clear the
Show Last 4 Digits check box to hide the last four digits of social security numbers.
This mask matches the following paerns: AAA-GG-SSSS, AAA GG SSSS, AAA-GG
SSSS, AAA GG-SSSS, AAAGGSSSS, AAA-GGSSSS, AAAGG-SSSS, AAAGG SSSS or AAA
GGSSSS. Hyphens, periods, and spaces are accepted as dividers between number
groups, as in the following examples:
 
534-14-3154
 
534.14.3154
 
534 14 3154
 

Phone number
 

Clear the Enabled check box to disable the phone number mask, or clear the Show
Last 4 Digits check box to hide the last four digits of telephone numbers. This mask
matches the common U.S. phone number format, with the optional country code 1 in
the beginning. Hyphens, periods, and spaces are accepted as dividers between number
groups, as in the following examples:
 
1(111)222-3333
 
1(111)2223333
 
1(111) 222-3333
 
1.111-222-3333
 
1.111.222.3333
 
1 111 222 3333
 
+1.111.222.3333
 
+1.111.2223333
 
+1.1112223333
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Custom Masks
 

Double-click in the Value eld next to the rst custom mask and enter the regular
expression for the paern you want to mask. This examples can help you congure
custom masks for new incident threads.
 
Example 1
 
Suppose you want to mask all account numbers that match the paern 123-123456.

Enter [0-9]{3}-[0-9]{6}. As a result, all account numbers that match this paern

will display as XXXXXXXXXX in new incident threads. (Notice that all characters are
masked, including the hyphen.)
 
Example 2
 
In this example, we’ll dene a mask for Canadian postal codes that match the paern
K8N 5W6.
 

Enter [A-Z]{1}[0-9]{1}[A-Z]{1} [0-9]{1}[A-Z]{1}[0-9]{1}. As a result, all

Canadian postal codes that match the paern K8N 5W6 will display as XXXXXXX. The
space is also masked.
 

State
 

This read-only eld shows the status of changes you make in any custom mask Value
eld. Statuses include Valid, Requires Test, and Error.
 
The status of this eld may change when you enter sample text in the Preview Text eld,
 and click the Test/Preview buon.
 

Preview Text
 

Click in this eld to test your mask paerns. Include samples that both match and
closely match the custom paern you congured.
 
For example, to verify that your Canadian postal codes mask is masking only the
alphanumeric paern you congured, enter the following postal code samples.
 

K8N 5W6
 

4J3 P2P
 

V5T 1Y9
 

Test/Preview
 

Click this buon to apply the congured system and custom masks to the sample
content in the Preview Text eld.
 

Result Text
 

This eld displays the masked preview text. Sample text that matches an enabled
system or custom mask will display as masked. For example, the Canadian postal code
samples in the Preview Text eld displays the following Result Text values.
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XXXXXXX
 
4J3 P2P
 
XXXXXXX
 
The masks applied to the rst and third text samples because they matched the
alphanumeric expression that we congured in our custom masks example. The second
text sample did not match the paern.
 
Be sure to test a variety of sample values and adjust custom mask values until the Result
Text displays text masked as you want. Also be sure to test inexact matches to ensure
that masks are not aecting content that should not be masked.
 

4. Click Save save your changes to system and custom masks.

Note:  You must deploy mask congurations before they will be commied to the database and
applied to new incident threads.

5. Click Deploy.
The Deploy window opens.

6. Enter the email addresses you want to send notications to in the Email Address eld.
Multiple addresses must be separated by commas. The logged-in sta account’s email address is automatically
added. Addresses entered in this eld receive emails when deployment completes or when an issue preventing
deployment is encountered.

7. Click Deploy to deploy your changes.
A Deploy message displays.

8. Click Yes to conrm the deployment.
The Incident Thread Masking editor will be unavailable until the deployment completes.

9. Click OK in response to the Deploying has nished message that displays.

Testing the accuracy of masking congurations in a test incident thread is an important security procedure. See Verify
Changes to Incident Thread Masking in a Test Incident.

Verify Changes to Incident Thread Masking in a Test Incident  
Testing the accuracy of masking congurations in a test incident thread is an important security procedure.

Though securing the customer’s personal assets is the most compelling reason to test with incidents, the integrity
of your incident information is also at stake. Because incident thread masks apply globally to all incident threads, we
strongly recommended that you test the deployed masking congurations in a series of incident thread entries and
verify that your masks apply to saved incident entries and incident emails the way you intend. This procedure is for
testing purposes only.

1. Create a test incident.
2. Associate a test contact with the incident.
3. Add a new customer entry, response, and private note. In each entry, enter text that both matches and closely

matches the mask paerns you have deployed. For example, enter 123-45-6789 and 123-45-67890 to test the
social security number system mask. Add other examples of text that match and closely match each of the
mask paerns you have deployed.
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4. Click Save.
5. Verify that only the appropriate paerns were masked in the incident thread and in the email response.

If you need to make further changes to your masks, you can return to the Incident Thread Masking editor.

Edit or Convert a Response Thread  
With incident thread correction you can convert a response thread entry into a note thread entry as well as edit or
remove text and images. This lets you remove content so it cannot be seen by customers in future responses.

There may be times when a response contains incorrect information or was inadvertently sent to a customer. Thread
entries can be edited after they are sent to a customer, leing you to convert a response thread entry into a note thread
entry and edit or delete text and images. With incident thread correction, you can view all responses for a particular
incident and select only those you want to change. After a response is modied, it cannot be converted back to the
original thread.

Note:  To access the Incident Thread Correction element, you must have Administration permissions set in
your prole. Additionally, you must have the Edit/Delete Commied Thread Content permission set in your
prole to edit incident thread content and delete images. See Proles.

1. Click Conguration on the navigation pane.
2. Expand Database, and then double-click Incident Thread Correction.

The Incident Thread Correction tree displays on the content pane.
3. Enter the reference number of the incident containing the thread entry you want to edit and click Search.

Threads from the incident display on the content pane.
4. Select the Make Note check box next to the response you want to convert into a note.

After saving your changes, the next time you open the incident, this information displays as a Note thread.
5. To remove inline images from the incident thread, do the following:

a. Select the Remove Thread Images check box.
b. Remove the <img> tag in the Thread column.

When you remove an image from a thread and the incident is refreshed, the image is removed from the
incident thread. If you do not remove the <img> tag in the Thread column, the image is replaced by a black
X icon when the incident is refreshed.

6. To edit the incident thread, do one of the following:

◦ Right-click in the Thread column and select Edit Thread.

◦ Double-click in the Thread column.

The Edit Thread window opens.
a. To search for a word or phrase in the incident thread, enter it in the text eld and click Find.

The search results are highlighted on the Edit Thread window.
b. Edit the incident thread.
c. Click X to close the Edit Thread window.

Your changes display in the Thread column on the Threads table.
7. Click Save.

The changes you made are saved to the incident.

Related Topics
• Incident Thread
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Add or Edit an Incident Stopword  
Incident stopwords are common words that are excluded from incident indexing and searching.

Service can suggest incident stopwords based on an analysis of incidents. You can then look at the list of suggested
stopwords on the Edit Incident Stopword list. Suggested stopwords are commented out unless you decide to include
them in the incident stopword list.

Note:  Incident stopwords can also be managed through the File Manager using the exclude_incidents.txt le.
See Manage Files with the File Manager.

1. Click Conguration on the navigation pane.
2. Expand  Service > Knowledge Base , and then double-click Incident Stopwords to review incident stopwords.

The Incident Stopwords editor displays on the content pane and suggested stopwords are listed in the
Suggested Additions box.

3. Select the stopwords in the Suggested Additions box and click the top double-right arrow to add the words to
the Active list.
The words you select are highlighted.

4. To add an additional stopword, enter the word in the text box on the Active list and click Add New.
5. To remove a stopword from the list, click the word in the Active list and click the double-left arrow.

The word is added to the Removals box, where it is highlighted.
6. Click Save.

Note:  Oracle Cloud Operations must run the Keywordindexer utility before your changes to the
stopwords list are active. To schedule this, submit a service request on our  support site.

How You Congure Advanced Routing for Incidents  
You can route incoming incidents to agents with specic language or product skills. Routing incidents to agents with a
specic skill set ensures that customers’ questions are answered accurately and eciently.

Products and categories selected by the customer and the language of the customer portal page from which the
incident was initiated determine which agent skills are required. If your customer is viewing the English version of the
customer portal when they initiate the incident, connecting them to an agent uent in English is going to provide the
best experience. If your customer is looking for information about your newest product, connecting them to an agent
who is an expert with that product is going to provide the quickest resolution. When an incident is initiated, if there
is no agent logged in with the specic skill required by your customer, advanced routing relaxes the skill requirement
immediately to prevent the incident from becoming stuck in the queue.

You can also use advanced routing primarily for the queue overow capabilities without dening skills.

Additionally, you can track the performance of advanced routing of incident sessions using standard reports available in
Public Reports/Service/Advanced Routing.

Note:  Advanced routing reports and conguration options will not be visible until Smart Interaction Hub is
enabled. To enable, contact your Oracle account manager.
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You will need to complete the following tasks before you can congure and use advanced routing for incoming
incidents.

• Dene products and categories you will use for advanced routing. See Search Optimization Using Products,
Categories, and Dispositions.

• Add product and category elds to the Live Help page of the customer portal. See Submit a Question Pages.

• Create an advanced routing incident queue. See Add or Edit an Incident Queue.

• Create and activate a rule to route incidents to the advanced routing incident queue. See Overview of Business
Rules.

• Assign advanced routing permissions to a prole. See Service Permissions.

Additionally, if you are using advanced routing with products or categories, you will need to congure skills and sta
account skill scores to nish the conguration and begin using advanced routing for incoming incidents. See Assign the
Skill Edit Permission in Proles, Add Skills, and Assign Skill Scores to a Sta Account.

Assign the Skill Edit Permission in Proles  
Assign the Skill Edit permission in proles for advanced routing.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to edit.

The Proles editor opens.
4. Click Permissions.

The Permissions page opens.
5. Select the Skill Edit check box in the Administration section on the Administration tab.
6. Click Save.

You must add Product Skills and Language Skills to the navigation set. See Edit a Navigation Set.

Add Skills  
Add skills for advanced routing.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Language Skills or Product Skills.

The Skills editor displays on the content pane.
3. Do one of the following:

◦ To add a skill, click New to display the editor.

◦ To edit a skill, click it in the tree.

You can delete a skill at any time by selecting the skill entry in the tree and clicking Delete. However, when you
delete a skill, all instances of the skill will also be deleted.

4. Enter eld information.

Field Description

Skill Information This section denes the name and type of the skill.

*Skill Name Enter the name of the skill.
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Field Description

Template ID This read-only eld identies the type of skill.

Label Select the interface.

Characteristics This section species the language, product, or category for the skill.

Language Select a language from the drop-down menu.
This eld is available only on the Language Skills editor.
 

Product Select a product from the drop-down menu.
This eld is available only on the Product Skills editor.
 

Category Select a category from the drop-down menu.
This eld is available only on the Product Skills editor.
 

5. Click Save.

Assign Skill Scores to a Sta Account  
Assign skill scores to a sta account for advanced routing.

You can assign skills to a sta account at the prole level or at the individual sta account level. Skills assigned at the
prole level are inherited by sta accounts assigned to that prole, but skills can be modied and added to individual
sta accounts.

1. Click Conguration on the navigation pane.
2. Do one of the following:

◦ To assign skills to a prole, expand  Sta Management, double-click Proles, and then double-click the
prole you want to edit. The Proles editor opens.

◦ To assign skills to a sta account, expand Sta Management, double-click one of the sta account
reports, and then double-click the individual account you want to edit. The Account Details editor opens.

3. Click Skills.
The Account Skill Scores window opens.

4. Click the Product or Language tab.
5. To add a product or language:

a. Select the product or language from the drop-down menu.
b. Click the Add, indicated by green plus sign.
c. Assign the skill an account score from the drop-down menu.

6. To modify a skill at the account level that was inherited by a prole, click the blue arrow next to the skill score.

Note:  Changing an agent’s inherited skill score to 0 is not the same as assigning an agent to a prole
without that skill. When the advanced routing queue has relaxed to a score of 0, the incident will be
routed to an agent with a skill score of 0. The incident will only be routed to an agent assigned a prole
without the skill if no other agents with that skill are logged in.

7. To delete a skill, click Delete, indicated by the red X next to the skill score.
Skills assigned at the prole level can only be deleted at the prole level.

8. Click Save.
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Answers  

Overview of Answers  
Customers use your site to nd answers to their questions about the services and products your organization provides.

To help your customers in nding the information they are looking for, you can create answers to common questions
and post them on your customer portal. As a result, you are able to provide a beer customer experience because your
customers are able to quickly nd the answers to their questions.

Oracle RightNow Cloud Service (Service) provides you with the tools for creating and publishing eective answers. You
can format answers to include links, tables, graphics, and other features, making your support site more interactive and
visually appealing. In addition, Service provides you with a revolutionary method of knowledge base management that
enables you to overcome the critical problems associated with a manually constructed knowledge base. Maintenance
of your knowledge base is minimized because of automated processes that learn from customers using your site, then
automatically rank answers and display the most useful answers rst.

Although you can add many answers to your knowledge base as your organization provides new products and services,
you might also spend a lot of time managing and updating your current answers. You can add information to existing
answers, including adding links to other answers, merging similar answers, and adding conditional sections within an
answer to control visibility of certain information.

When adding and editing answers, the toolbar lets you perform advanced actions on your answers such as inserting
hyperlinks, images, and tables. As your knowledge base grows more complex, you can insert links to other answers,
associate answers with multiple access levels, insert conditional sections, and merge similar answers.

To learn how to start your knowledge base and keep it organized and up-to-date, see How to Seed Your Knowledge
Base. To learn more how to work with answers on the Service Console, see Process of Creating and Updating Answers.

Related Topics
• Answer Management

• Add an Answer

• Edit an Answer

Process of Creating and Updating Answers  
You can improve customer experience by having answers to common questions readily available on your support site.

With Service, you can create answers about your services and products and post them on your site. You can also create
public answers from incidents in your knowledge base, or agents can propose incidents to become answers.

After an answer is in your knowledge base, you can update it at any time, making sure your knowledge base contains
only the most up-to-date information. For example, you can dene specic dates to review an answer and change the
answer to Private while you update the details. You can format answers with the HTML editor, which lets you create
links, tables, and graphics, and use other HTML features without prior HTML knowledge. As a result, your support site is
more interactive and visually appealing.
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This owchart shows the process of creating and updating an answer.
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Related Topics
• Add an Answer

• Edit an Answer

Answer Reports  
When you click the Answers buon on the navigation pane, the navigation list displays all of the reports and items
added to this buon by your administrator.

The Answers buon, plus all the other buons you have access to, are part of the navigation set dened in your prole.
Answer reports can be placed in other navigation lists, not just the Answers navigation list.

Note:  If you have permission to customize your navigation set, you can add other items, including any reports
you have permission to access, to your Answers navigation list or any of your lists.

The answer information displayed on the content pane depends on the answer report you opened and which elds
were dened when the report was created. The Answers Default report, for example, displays the answer ID, summary,
language, access level, status, assigned, and date the answer was last updated. The ribbon lets you manage answers
and provides data analysis options for working with reports. You can right-click any answer and select the same
functions that are available on the ribbon.

Tip:  Besides selecting an answer from a report, you can search for answers from a report or use Quick Search.
See Record Search Options.

Related Topics
• Answer Ribbon

Answer Workspace  
Service provides a standard workspace for working with answers.

The workspace denes which elds are available, what buons display on the ribbon, and how the information is
organized on the content pane. This is an example of the standard answer workspace.

Your organization can use this standard workspace, or your administrator may have created one or more customized
workspaces. Your prole denes the workspace you see when you work with answers, whether it is the standard
workspace or a customized workspace. The standard workspace is used to describe how you work with answers, but
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keep in mind that the workspace your prole uses might display a dierent combination of elds or display them in a
dierent location on the content pane.

Answer Ribbon  
A standard ribbon exists for working with answers.

Group/Buon Description

Editor

Undock Click this buon to undock the answer editor from the console and display it in a separate window.
 

Save

Save Click this buon to save the answer without closing it. The answer remains open.
When you save an answer, it is evaluated by the rules engine. If your administrator added answer rules
and the answer matches one or more of those rules, it is possible that the answer will be modied by
rule actions when you save it. For example, a rule can change an answer status or answer access level.
See Overview of Business Rules.
 

Save and Close Click this buon to save and close the answer.

Actions
With the exception of the New buon, the buons in this group are not enabled until after you have saved the answer you are adding.
 

New Click this buon to add an answer. See Add an Answer.

Refresh Click this buon to refresh the current answer.

Preview Click this buon to view the answer as it will appear to your customers. See Preview an Answer.

Check Links Click this buon to check the validity of hyperlinks and answer links in the answer. See Validate Links in
an Answer.

Validate Category Links Click this buon to check if the products and categories you selected for the answer are linked.
If the categories you selected are linked to selected products, a message informs you that all selected
categories are linked to at least one selected product. If you select one or more categories that are not
linked to the products you selected, a message lists the categories that are not linked to any of the
selected products. See Product Linking.
 

Print Click this buon to print the answer. See Print a Record.

Copy Click this buon to copy the answer. See Copy a Record.

Delete CAUTION:  Deleting an answer aects all relationships associated with the answer.

Click this buon to delete the answer. See Delete an Answer.

Proong

Spell Check Click this buon to check the spelling of any answer elds that have spell check enabled. Text on the
answer Content tab is automatically checked for correct spelling. See Spell Checking.

Links and Info
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Links Click this buon to select a URL from the list of links added by your administrator.

Info Hover over this buon to see details about the answer, including when it was created and last updated,
 the sta member who last edited it, and the date of the last answer update notication. If the answer is
in a rules state or has an escalation level, that information also appears.

Answer Record Tabs  
Record tabs contain elds and options for adding additional information to answers.

The organization of these tabs lets you manage and edit information and quickly move between the tabs as you work
with answers. The information you can access on each tab depends on the permissions set in your prole.

Note:  If you make changes to elds on any of the answer record tabs or any of the windows opened through
the record tabs, you must save the answer in order for all changes on the record tabs to take eect. If you close
the record without saving changes, those changes are lost.

• Content tab—Contains the elds for adding and editing answers, including keywords, answer type, question,
and answer. Also included is the Toolbox which contains tools for inserting hyperlinks, images, tables, buons,
answer links, and conditional sections. See How You Add Answers for Multiple Interfaces.

• Products/Categories tab—Lists all products and categories that are associated with the answer. You can select
which products and categories are associated with an answer to enhance search results for customers. See
Associate Products and Categories to an Answer.

• Tasks tab—Lists all tasks associated with the answer. The number of tasks associated with the answer displays
in parentheses next to the tab name. For each task, the tab displays the task name, due date, completion date,
sta member assigned to the task, and priority. You can open, copy, delete, print, and forward any task and
mark tasks complete by clicking a buon on the tab toolbar or by right-clicking the task and making your
selection. See Add or Edit a Task for an Answer.

• Details tab—Contains the elds for answer details, including Display Position, Review On, Notify Subscribers,
and Publish On. See Add Answer Details.

• Aachments tab—Lists all aachments associated with the answer. The Aachments tab displays the le name,
size, date created, date updated, and a description for each aachment. See to Overview of the Aachments
Tab.

• Audit Log tab—Lists all actions taken on the answer by all sta members. Also displayed are automatic changes
initiated by Oracle Service Cloud that resulted from the application of business rules. When an action is
generated by the system, the Who eld contains Administrator. You can also see who worked on the answer,
when it was added or updated, the actions taken, and descriptions of the actions. See Audit Logs.

• Relationships tab—Contains the elds and tools necessary to manage answer relationships, including sibling
answer relationships, manually relating a new or existing answer with a current answer, and viewing, editing,
printing, previewing, and promoting related answers. See Answer Relationships.

• Notes tab—Contains answer notes that can be sorted by date. Remember that customers never see the answer
notes added by sta members. See Add an Answer.

• Analytics tab—Contains the Actionable Knowledge Foundation reports, which display information about the
answer being viewed or edited. By reviewing these reports, you can learn how your knowledge base is being
used and make the necessary adjustments to improve customer satisfaction. See Answer Evaluation Using
Analytics.
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• Model Questions tab—Lists all Oracle RightNow Virtual Assistant Cloud Service (Virtual Assistant) model
questions that are associated with the open answer. Virtual Assistant must be enabled for this tab to display.
See Model Questions.

Answer Tasks Tab Toolbar  
The Tasks tab contains a toolbar for working with the tasks associated with an open answer.

Buon Description

Add Click this buon to add a new or existing task:
• Add New—Select this option to add a task.

• Add Existing—Select this option to search for a task to add to the answer.

Open Click this buon to open or edit the selected task. If you have read-only access to tasks, you can open
the selected task but all options to edit the task are disabled.

Print Click this buon to print the selected task.

Copy Click this buon to copy the selected task.

Delete Click this buon to delete the selected task.

Remove Click this buon to remove the task association from the answer.

Complete Click this buon to mark the task complete. You can set multiple tasks to complete by pressing Ctrl
while selecting each task and then click the Complete buon.

Forward Click this buon to forward the task to the selected recipient.

Options Click this buon to display a drop-down menu of Analytics options.

How to Seed Your Knowledge Base  
Because Service can start with only 15-20 answers, the need for a comprehensive initial knowledge set is eliminated,
which signicantly speeds and simplies implementation.

Most organizations can build their initial knowledge base from existing online questions and answers, documents, or
customer support interactions. Instead of constructing a complete set of answers up front, you can take advantage of
the ongoing questions that your customers submit to capture real-world issues.

As customers submit questions and your organization’s support sta solves these issues, you are supplied with content
that is perfectly suited for public answers. The Propose Answer feature enables agents to suggest that certain incidents
become public answers, allowing you to seamlessly create public answers from the real issues that your customers are
facing. This method of organic growth eliminates the need for a complete initial group of answers, signicantly reducing
your ongoing maintenance tasks, and ensures that your knowledge base contains useful, eective content. Additionally,
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as you foresee that upcoming events (for example, a product release, seminar, or conference) may increase queries on
your site, you can manually add answers to the knowledge base to answer questions before they are even asked.

Note:  Agents can propose incidents as answers only if they have Propose permission in their prole. See
Service Permissions.

Dene a Process for Publishing and Reviewing Answers  
Before you develop your knowledge base, you must have a process for publishing answers.

This process outlines the steps for eciently capturing incident information and creating answers.
1. Dene a process for proposing new answers—Typically, to publish an incident as an answer, the incident

threads will need to be summarized to cover a broader topic scope. To take advantage of agent expertise, we
have found this approach to be successful.

a. An agent modies the existing incident and writes the new answer as a Note thread with the public
audience in mind, following established standards and guidelines. Two key items to include are the
incident reference number and the sta member’s name.

b. An agent proposes the incident. An answer is created, and the summary and threads from the existing
incident are copied to the Question eld of the new answer.

c. You review, edit, and format the proposed answer, and then publish it. This method uses an agent’s
knowledge for writing the bulk of the answer, and then you prepare the answer for public viewing.

2. Dene an approval review process for new answers—After an answer has been proposed for public use, you
may want managers or sta members from other areas in your organization to review the information to
ensure technical accuracy of the methods and procedures dened in the solution.

3. Determine the audience of new answers—Before publishing an answer, determine which interfaces and
customers you want to be able to view the answer. You can control this visibility through the visibility of answer
statuses, answer access levels, languages, products, categories, and conditional sections. See How to Control
Answer Visibility.

4. Determine the display position of new answers—You can set the position of a new answer relative to other
answers on the Answers page on the customer portal. When adding or editing an answer, you can choose to
place new answers at the top, middle, or boom of the answers list, or x them at the top, middle, or boom.
If you want to give added visibility to newly published answers, place them at the top and then allow their
historical usefulness to dictate their future placement. In this way, your customers are aware of new answers as
you publish them.

5. Notify sta of new answers—Your administrator can use standard reports to show answer notications by
answer, product, category, or subscribers. Standard reports for answer notications can be scheduled to be sent
to other sta members and are located under Public Reports/Service/Site Reports/Answer Notications.
See How You Distribute Reports and Dashboards.

After following these steps to identify your process for publishing answers to your customers and notifying sta
members about new answers, you can begin creating answers.

Best Practices for Creating Eective Answers  
Creating useful answers is a straightforward process with a few simple guidelines. By following these guidelines, you will
enhance the search process for customers, allowing them to nd pertinent information quickly without needing to do
multiple searches.

A knowledge base containing well-crafted answers will also optimize the self-learning features of Service that
continually index, group, link, and rank the answers in the knowledge base. These self-learning features are the
backbone of self-service, enabling you to present the most historically useful answers rst and to suggest answers
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related to the customer’s current question. In addition, eective answers will make your maintenance tasks easier as
information ages and changes.

Use these guidelines to create clear, focused answers:

• Create one-topic answers—Think of each public answer in your knowledge base as one topic or the answer
to one question. When a customer comes to your site with a question, they want quick resolution. One-topic
answers improve searching and grouping, which enable customers to easily nd answers. One-topic answers
provide brief, pertinent information without cluer. A knowledge base of unique answers also simplies
management and maintenance.

• Provide adequate detail—Because Service indexes the text of the Summary, Question, and Answer elds into
words and phrases for text searching and answer grouping, answers should contain an adequate amount of
text that explains the issue. With limited text, there are very few indexed words for the answer, and the words
that are indexed cannot fully represent the context of the answer. As a result, the answer may be dicult to nd
during text searching. With too much text (over two pages), you run the risk of writing about several topics and
covering too broad of a context. The resulting set of indexed words may not span the entire text of the answer.
In eect, the answer can be found during dissimilar searches in which that answer is not relevant.

• Write a concise summary—The quality of the summary, meaning how closely it summarizes the contents of
an answer, is critical to the eectiveness of the answer and aects its display position, how it links to related
answers, and how it is grouped with similar answers. On the Answers page, customers will choose to open and
read or skip over an answer based on the summary. Without a concise summary, customers may not open the
answer, which directly impacts its display position and how it is linked with other answers. The summary should
state what the customer can expect to learn by reading the answer or what question will be answered.

• Create explicit keywords—Sometimes, you may not be able to capture the entire contents of an answer in
the one-sentence summary. The Keyword eld is an additional eld, not viewable by customers, used during
keyword indexing of an answer. You can enter supplemental keywords, phrases, or text that represents the
answer content. Keywords should be separated by commas, with grouped words separated by spaces (for
example, “cell phones, calling plans, accessories”). You should be deliberate with the words you enter because
they are weighted higher than indexed words and phrases not in the Keyword eld. Be sure to include a
thorough, yet concise section of keywords.

After creating a knowledge base of eective answers, you will want to publish the answers to be accessed by customers.
By understanding the factors that determine answer visibility, you can eectively control how and when answers are
seen on the customer portal.

How to Control Answer Visibility  
Answers can be either public or private, as well as have specic visibility seings for each interface or for contacts based
on access levels dened in their service level agreements (SLAs).

When you publish answers, you make them available to the public on your customer portal. Whether answers are visible
on your customer portal is determined by what you specify in certain elds. The ve key elds that determine how
and where answers are presented are Answer Status, Answer Access Level, Language, Products and Categories, and
Conditional Sections.

In order for answers to appear on the customer portal, the Status, Access Level, Language, Product, and Category elds
must be set to a visibility that allows access by customers. If even one eld does not allow visibility, the answer will not
be available on the customer portal. In addition, if you have sections within an answer with restricted visibility, that
section must be assigned an access level associated with the answer. The ve elds that control answer visibility are
described in detail below.

• Answer status—The primary factor that determines the visibility of answers is answer status. There can be
many custom answer statuses, but all must be either a Public or Private status type, which is determined when
the custom status is created. Answers set to a status that has a Private status type can never be viewed on the
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customer portal, regardless of their access or language assignment. Public answers may be viewable through
the customer portal, depending on the other elds selected. Two of the default answer statuses are Review and
Proposed, both of which have a Private status type. When agents propose an incident to become an answer, it
is copied and set to the Proposed status with an access level of Everyone. Since the Proposed status is a Private
status type, the answer will not be visible to customers. An answer changes to the Review status when its solved
count reaches zero or when the date specied when adding or editing an answer is reached. The Review status
will automatically remove the answer from the customer portal. See Add or Edit an Answer Status.

• Answer access level—Access levels determine whether customers can view answers on a per-interface basis.
If an answer is set to an access level that has customer visibility on one of the interfaces, then that answer is
viewable by everyone on that interface, provided the remaining elds also allow visibility. If an access level
does not provide visibility to customers for a certain interface, access can still be given to specic contacts by
assigning them SLAs that allow privileged access. One of the default access levels for answers is Everyone.
This access level allows all customers to have access to the answer on all interfaces. See Add or Edit an Answer
Access Level.

• Language—Answer visibility is also determined by the language assigned to it. If assigned to a specic
language, an answer will only be visible on the interfaces using that language, as long as the answer status and
access level also allow visibility.

• Products and categories—The visibility seings for the products and categories associated with the answer will
also aect the visibility. If the answer is assigned to a product or category that is not visible to customers on a
particular interface, the answer will also not be visible to customers, unless it is assigned to another product or
category that is visible on the interface. In other words, if you have an answer that is assigned to two products,
and one of the products is not visible on the interface, but the other product is, your answer will appear on the
interface. However, if the answer is assigned to two products, and neither product is visible on the interface,
your answer will not appear on the interface under any circumstances. See Search Optimization Using Products,
Categories, and Dispositions.

• Conditional sections—Conditional sections help control visibility of certain sections within an answer. If a
section of the answer is assigned an access level that is not visible to customers on a particular interface, but
the answer is visible, then customers are able to view the answer but not the conditional section. For more
information about conditional sections in answers, see Insert a Conditional Section.

What to Do When Answers Are Not Visible  
If an answer (or section within an answer) you want your customers does not display on the customer portal, answer
these questions to troubleshoot the problem.

Tip:  You can preview an answer to view it as customers will see it on the customer portal.

• Is your status set to Public or a custom status with a status type of Public?

• Does the access level have visibility for the desired interface?

• Is your language for the answer appropriate? If you have more than one interface with multiple languages, is
the answer set to the same language as the interface you are trying to view it on?

• Are your products and categories visible on the interface? Is your answer assigned to at least one product/
category that is visible to customers?

• Are the answer sections within the answer visible as you intended?

If the answer to any of these questions is “no,” make the appropriate changes and use the preview to see if the answer
displays. If you are unsure of the answer to any of the above questions, contact your administrator.
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Related Topics
• Preview an Answer

Answer Management  
Many of the maintenance tasks related to organizing the answers in your knowledge base are automated in Service.
This allows you to focus on improving and maintaining the content of answers.

This list outlines these automated processes and describes the tools designed to aid with answer management.

• Aging of answers (solved count)—Just as frequently used answers will rise to the top of the knowledge base,
lesser-used answers will move to the boom through aging of the answers solved count. See Solved Count
Aging.

• Answer review and publish feature—By using the Review feature, you can easily monitor answers without
needing to constantly review them. The Review feature will automatically set an answer to the Review status
when the solved count reaches zero or on specically dened dates. You can also manually set a review date,
the date that you want the answer to go into review status. In addition, you can set a publish date for a date in
the future. In this way, you can schedule an answer to become public automatically without having to publish.
See Answer Review.

• Data mining—The processes of linking similar answers for the Related Answers feature is triggered
automatically and occurs periodically when modications are made to the knowledge base. These processes
implement innovative technologies to cluster and link answers containing similar content.

• Customer feedback—Service closes the loop by providing customers with a method to submit comments and
suggestions on answers. Any feedback submied through the question, “Is this answer helpful,” is turned into
a Feedback for Answer incident accessible to agents. You can use this feedback to address content holes and
improve answers.

• Customer visit tracking—Service tracks customer actions as they move through your support site, recording
where they went, what they searched for, and the answers they viewed. Using the Web Visit feature, agents can
view this click-stream data to respond more appropriately to customer questions. This information can also
indicate areas of the knowledge base that need to be tuned. See View Web Visit Information for an Incident.

• Knowledge base reports—A series of standard reports record how customers are navigating the knowledge
base, including the products and categories they are searching on, the search text they are entering, and the
answers they are viewing. These reports provide a unique and powerful perspective into how the knowledge
base is performing and enable you to pinpoint weak areas and tune the knowledge base content. See Answer
Evaluation Using Analytics.

Answer Ranking  
Through answer click-track analysis and feedback, your answers are automatically organized.

Answer rankings are constantly updated using the solved count value and presented to your customers with the most
useful information rst. Service uses three techniques to gather useful information about answers.

• Explicit customer feedback—By default, the Answers page oers customers a way to rate answers through the
“Is this answer helpful?” option. Their responses automatically raise or lower the solved count of answers.

• Explicit ranking of the answers—You can explicitly rank answers at certain levels in the knowledge base using
the Display Position seing. This is often useful when new issues arise.

• Click-track analysis—Service analyzes the path each customer takes through the knowledge base. The use and
benets are two-fold:
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◦ Answer relatedness—An anity map is built which relates answers that customers view to other answers
viewed during the same visit. Through the SmartAssistant feature, Service suggests answers to them
based on the historical relationships of that answer to other answers in the knowledge base. The
suggested answers appear as learned links on the Relationships tab.

◦ Implicit ranking—The click-track data is also used for answer ranking. Each time an answer is viewed by a
customer or suggested by an agent, its solved count is increased.

Related Topics
• Answer Relationships

Answer Ranking Through Solved Count  
Solved count collects information about the usefulness of answers in your knowledge base and uses this data to rank
your answers.

Implicit data is compiled by how customers select and view answers. Explicit data is compiled by how customers rate
the eectiveness of individual answers. Both long-term and short-term solved counts are used to calculate the score.
Solved counts from the customer portal account for 75 percent of an answer score, and agent solved counts contribute
25 percent. Using the solved count values, Service can dynamically rank the answers by their usefulness and present
customers with the most eective answers rst. By default, the Solved Count feature is enabled.

An answer score value is a calculated value equal to the answer solved count combined with any “x at” positions
specied for the answer in the Display Position drop-down menu when adding or editing an answer. For more
information about the options available, see Add Answer Details.

• Implicit ratings—Implicit ratings are gathered as customers view answers. If a customer views an answer, the
solved count of the rst answer is increased, but not as much as the second viewed answer. In other words,
the answer that the customer views last receives the largest solved count increase. Previously viewed answers
receive a smaller increase in their solved counts. The solved count is also increased when an agent uses a
SmartAssistant suggested answer when responding to a customer’s question.

• Explicit ratings—Explicit ratings are gathered from the response to the question, “Is this answer helpful?”. This
question is displayed on the Answers page on the customer portal.

Solved Count Aging  
Over time, the solved count of an unused answer will gradually decline or age.

If an answer has not been viewed for thirty days (the default seing), the solved count is automatically reduced. The
solved count of unused answers also declines at a constant rate over time. Ultimately, if an answer has not been viewed
for an extended period of time, the answer solved count can reach zero.

When you rst create an answer, its rank in the knowledge base is low, thereby making it more dicult to access.
Generally, you would not want aging to occur on new answers. By default, new answers will not be aged for thirty days.
Your administrator can change the seing to specify an alternate aging period. Your administrator can also control
the frequency and aggressiveness of aging on answers depending on your organization’s specic needs. Contact your
administrator for more information about the Solved Count seings dened in your application.

When an answer solved count reaches zero, this usually means that the answer has not been viewed for a long time,
and it is safe to assume that the information may be outdated or not useful. By default, these aged answers are
automatically set to the Review status when their solved count reaches zero. This enables you to easily sort the outdated
answers and update them. By default, the Review feature is disabled. Contact your administrator to enable this feature.

Now that you have thought about your processes for publishing answers and understand how the knowledge base
grows and presents information, you need to know how to keep your knowledge base accurate and up-to-date.
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Customer Feedback  
Your customers can provide feedback on answers that do not completely solve their issues by answering the question,
“Is this answer helpful?”

This feedback can be extremely valuable for understanding customer needs and updating your answers accordingly.
When a customer submits comments or suggestions from the feedback form, an unresolved incident is automatically
created. In some instances, customer feedback can be incorporated directly into an existing answer. In other cases, new
answers might need to be created.

Answer Review  
Over time, the content of your answers can become outdated.

Reviewing answers should be a central part of maintaining your knowledge base to ensure that the content is current,
relevant, and useful. You might want to review answers at set intervals, such as every six months, or review answers in
conjunction with new product releases or upgrades. If you have a group of answers for a particular product or service,
you might want to review the answers in bulk. This can help you develop and prepare information in advance.

By using custom elds, custom answer statuses, and answer access levels, you can easily sort and work on answers in
dierent stages of editing. For example, your administrator might have created a private answer status called Manager
Review for newly crafted answers that will require manager approval before being published.

When editing an answer, you can set a specic date to review a particular answer. On the review date, the status of the
answer will change from Public to Review. Also, by default, if an answer is not viewed by customers, the answer solved
count will reduce to zero, and the status of the answer will change to Review.

Tip:  To maintain information about a particular topic in one answer, use the Notes tab to store upcoming
information or material you are currently editing.

Related Topics
• Solved Count Aging

Content Hole Identication  
You should actively investigate material for new answers by reviewing recently submied incidents.

Agents can become overwhelmed with assistance requests, and despite their best intentions, they might forget or
not have enough time to propose new answers. By continually capturing questions submied by your customers and
crafting new answers that solve those questions, you can publish answers for the most relevant and current issues.

As you search the most recently solved incidents, click the Web Visit tab to see if customers searched or viewed any
answers before submiing their incident. In this way, you can locate answers that are incomplete or need updating.

Note:  Before creating a new answer, search for existing answers that cover the topic. You can avoid
duplication by updating an existing answer, rather than creating a new one.

Related Topics
• View Web Visit Information for an Incident
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Answer Evaluation Using Analytics  
Service has several standard reports that track customer activity and provide data on the eectiveness of your
knowledge base.

One of the most useful reports for identifying subject maer holes in your knowledge base is the Information Gaps
report located in Public Reports/Service/Knowledge Base Reports. This report creates knowledge clusters from your
existing incidents and compares them to your answers, alerting you when incidents are created that are not closely
matched to any answer. By browsing the incidents and their cluster topics, you can evaluate the need for additional
answers in your knowledge base.

The Analytics tab on the standard answer workspace displays reports about the answer currently being viewed or
edited. The reports are located in Public Reports/Service/Site Reports/Actionable Knowledge Foundation. By
reviewing the reports on the Analytics tab, you can ne-tune individual answers to make them more relevant for the
customer portal and ultimately improve customer satisfaction.

The Analytics tab contains a toolbar for performing actions on the reports. Three tabs are located under the toolbar:
the Descriptions tab, which provides descriptions for the reports, and the Summary and Top 10 tabs, which display the
reports.

By default, the Summary tab opens and displays these reports.

• Answer Usage—This report provides contact usage details on a per-answer basis.

• Answer Click-Through Rate—This report provides a list of customer portal pages and actions and details about
the visits for each.

• Answer Eectiveness—This report provides details about the actions performed on individual answers to
provide an overall assessment of how eective each answer is.

• Escalation Details Per Answer—This report provides information about the escalations that occurred after a
particular answer was viewed.

The Top 10 tab displays these reports.

• Top Searches Per Answer—This report provides the top ten searches that returned an answer which was viewed
by a contact.

• Top Previous Answers by Answer—This report provides a list of answers viewed during a selected time period,
along with the top ten answers that were most often viewed previous to that time period.

• Answer Referrers—This report provides the domain names (www.example.com) that visitors arrive from and
the number of times (visits) a given answer was viewed by individuals from those domains.

• Top Next Answers by Answer—This report provides a list of answers viewed during a selected time period,
along with the top ten answers that were most often viewed after that time period.

Answer Link Checking Using Analytics  
Maintaining your knowledge base includes making sure that links in answers to other answers and external sites are not
broken. Analytics provides reports for checking answer links.

These reports are located in Public Reports\Common\Site Administration\Link Checker.

Report Description

Broken URIs Use this report to search for broken links to other answers and external references. After searching,
 click the link in the Usage column to list where the broken links occur.
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Report Description

Top URIs Use this report to search for the most commonly used links to other answers and external references.
After searching, click the link in the Usage column to list where the links are used.

URI Sources Use this report to search for answers that have links. After searching, double-click an answer to open it
to examine the links.
You can embed the URI Sources report in the answer workspace. In the answer workspace, the URI
Sources report automatically lters by answer ID and show all answers that link to the answer that is
currently open.
 

Add an Answer  
Key answer elds are used to specify the answer summary, status, language, access level, and the sta member
assigned to the answer.

Key answer elds are located at the top of the content pane. Field marked with a red label and an asterisk are required
and must be completed before you can save the answer. The key answer elds that display on the content pane vary
depending on the permissions set in your prole.

You can create dierent answer types when adding answers to the knowledge base. Answer types give you more
exibility in providing information to your customers. You can add these types of answers:

• HTML—Answers that appear to customers as standard HTML on the customer portal. When you create an
HTML answer, you can use the HTML editor to view answers as customers will see them. See HTML Editor for
Answers.

• URL—Answers that consist of a link to an external URL. The URL address and the content of the web page are
displayed. See Add a URL Answer.

• File aachment—Answers that appear as le aachments. File aachment answers link to information
contained in another document and appear to customers on the customer portal as le aachments. See Add a
File Aachment Answer.

CAUTION:  When you change the answer type, certain elds are removed. For example, when you change
an HTML answer type to a URL answer type, you will lose the Question, Answer, File Aachments, Manually
Related Answers, and Learned Links elds. Read the Conrm Answer Type Change prompt carefully before
you continue.

1. Do one of the following:

◦ From an open answer report, click New.

◦ If your navigation set is congured to add answers from the le menu, click File and select Answer. See
Congure the File Menu.

The New Answer editor displays.
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2. Enter eld information.

Field Description

*Summary Enter the subject of the answer in this eld.

*Status Click this drop-down menu to select an answer status.

*Language Click this drop-down menu to select a language.

Assigned Click this drop-down menu to select a sta member to assign to the answer. Only sta
members who have permission in their prole to create answers are listed. By default,
the sta member who created the answer is selected.

Tip:  Use the Find feature at the boom of the Assigned drop-down menu to
locate sta members quickly. Wildcards are supported when searching sta
members and groups. You can search strings that include a space by entering

%+Space+character, which is helpful when searching last names.

For example, entering %+Space+b returns all last names starting with the

leer b. There is also an implied wildcard when searching, so entering b in the

Find eld returns all items containing the leer b.
 

Access Level Click this drop-down menu to select an access level. See Associate an Answer with
Multiple Access Levels.

3. To add a ag to the answer, click the area next to the white ag above the answer elds.
4. Select the answer type.

See HTML Editor for Answers, Add a URL Answer, or Add a File Aachment Answer.
5. To add keywords to associate with the answer, click the Content tab and enter the words in the Keywords eld.

Note:  Separate keywords by commas, with grouped words separated by spaces (for example,
phone,call plan,nationwide). Keywords are used by the search feature. Any keywords you type are
given the greatest weight when a customer is searching on the Answers page. In addition, words in
products and categories and their descriptions are used as keywords for answers.

6. To associate products and categories with the answer, click the Products/Categories tab.
7. To add tasks to the answer, click the Tasks tab.
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8. To add additional details to the answer, including seing Publish On and Review On elds, click the Details tab.
9. To aach les to the answer, click the Aachments tab.

You can aach as many les as needed to associate with an answer. Aachments appear as clickable links when
a customer views an answer. They can also be indexed as searchable text. Therefore, you can choose whether
each document is indexed when managing your le aachments. See Conguring Oracle Service Cloud for
Customer Portal.

a. Click Add Files under the Aachments for This Answer section.
b. To aach les that will be shared with sibling answers, click Add Files under the Aachments For This

Answer and All Sibling Answers section.
The Aachments For This Answer and All Sibling Answers section displays only if the Siblings Visible
property for the File Aachments relationship item on the answer workspace is set to True. See Sibling
Answers and Options Properties.

10. To view the answer audit log, click the Audit Log tab.
11. To manage answer relationships, including sibling answers, manually related answers, and learned links, click

the Relationships tab.
12. To enter notes about the answer:

a. Click the Notes tab.
b. Click Add.
c. Enter the notes in the Answer Note eld.

Notes will not be visible to customers on the customer portal.
13. Click Save.

The answer is added to the knowledge base.

If you set the answer status to Public, the End-User Visibility window opens and displays all interfaces associated with
the answer, along with the answer product and category visibilities. (A green check mark signies that a product or
category is visible on a particular interface, whereas a red X signies that it is not).

• To perform a visibility check when the answer status is changed to Public, select Only When Status is Changed
to Public Type.

• To perform a visibility check every time the answer is saved, select On Every Save.

Related Topics
• Answer Relationships

• Audit Logs

• Add a Flag to a Record

• Associate Products and Categories to an Answer

• Add or Edit a Task for an Answer

• Add Answer Details

• Creating an Answer (video)

HTML Editor for Answers  
You can use the HTML editor for answers to design creative and eye-catching answers. The default answer type is
HTML.

The Content tab contains three subtabs (Question, Answer, and Quick Preview) that you can use to create and preview
content for answers. You can design your answer content using design mode or source mode. See Add an HTML Answer
in Design Mode and Add an HTML Answer in Source Mode.
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In design mode, you can create dynamic, well-formaed answers without previous HTML experience. The HTML editor
contains many of the same options available in basic word processing applications so you format your text and add
graphics, links, and other common HTML features. You can also add links that reference other answers. In source mode,
you can create answers using HTML source code. By default, the source mode editor displays your code in colored text
to indicate structure and syntax.

For design mode to be available with the HTML editor, the HTML Design Mode permission must be selected in your
prole. For source mode to be available with the HTML editor, the Source Mode permission must be selected in your
prole. See Service Permissions.

Regardless of which mode you use to create answers, you can preview how the content diplays to customers on the
customer portal from the Quick Preview tab.

Note:  By default, the HTML editor cleans HTML code to meet XHTML compliance specications. This results
in adding XHTML doctype declarations to the resulting HTML code. If this functionality is disabled through the
HTML_TIDY_ENFORCE_XHTML conguration seing, the content will not be cleaned upon saving the answer.

Add an HTML Answer in Design Mode  
Design mode lets you create dynamic, well-formaed answers without previous HTML experience.

1. Do one of the following:

◦ From an open answer report, click New.

◦ If your navigation set is congured to add answers from the le menu, then click File and select Answer.
See Congure the File Menu.

The New Answer editor displays.

The HTML option is selected, and the Question tab is active, by default.
2. Enter a one-line summary in the Summary eld.

This eld displays as the subject of the answer on the customer portal.
3. Use the HTML editor to add the question portion of the answer.

General functions available on the toolbar let you do the following:

◦ Cut, copy, and paste.

◦ Search for text.

◦ Undo and redo changes.

◦ Format text in bulleted or numbered lists.

◦ Adjust indentation.
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◦ Center, left-justify, or right-justify text and images on the page.

◦ Change the font using the system fonts, including the default font.

◦ Change the font style, size, and aributes (highlighting, bold, italic, underline).

◦ Apply specialized formaing, including super and subscripts.

Other functions are also accessed through the toolbar.

Buon Description

Block Quote Click this buon to set o text as a block quote (<blockquote> tag).

Create Div Container Click this buon to create a DIV block (<div> tag). You can insert new lines and line
breaks between DIV containers.

Insert HTML line break Click this buon to insert a line break (<br/> tag).

Source Click this buon to switch between source and design mode. In source mode, the
toolbar buons are disabled except for Source.

Link Click this buon to insert a hyperlink. See Insert a Hyperlink.

Unlink Click this buon to remove a hyperlink.

Image Click this buon to insert an image. You can use the mouse to resize an image after
inserting it. See Insert an Image.

Table Click this buon to insert a table. See Insert a Table.

Insert Horizontal Line Click this buon to insert a horizontal line.

Smiley Click this buon to open the Insert Smiley window, then click an emoticon to insert it at
the current cursor position.

Insert Special Character Click this buon to open the Insert Special Character window, then click a symbol to
insert it at the current cursor position.

Anchor Click this buon to insert an anchor in the answer. See Insert an Anchor.

Answer Link Click this buon to insert a link to another answer. See Insert an Answer Link.

Conditional Section Click this buon to insert a section with certain visibility restrictions within the answer.
See Insert a Conditional Section.

Smart Merge Click this buon to merge similar answers using Smart Merge. See Merge Similar
Answers.

Search Knowledgebase Click this buon to search for an answer in the knowledge base and append the content
with the current answer. See Append Answer Content.

4. Click the Answer tab, then use the HTML editor to create the answer content.
5. Click Full Screen to use the HTML editor in undocked full-screen mode. Click Exit Full Screen to exit full-

screen mode.
6. To preview the answer content, click the Quick Preview tab.
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Customer portal themes do not display on the Quick Preview tab. You can also preview the answer and select
assigned access levels to view answer visibility by clicking Preview on the ribbon.

7. Click Save.

Related Topics
• Preview an Answer

Add an HTML Answer in Source Mode  
Follow this procedure to add an HTML answer in source mode.

Syntax is highlighted in source mode. You can also search and replace code.
1. Do one of the following:

◦ Click New.

◦ If your navigation set is congured to add answers from the le menu, click File and select Answer.

2. Click the Source icon on the HTML editor toolbar.
When adding an HTML answer in source mode, the HTML editor toolbar buons are disabled, except for the
Source icon.

3. Enter the HTML code to create question content.
4. Click the Answer tab and enter the HTML code to create answer content.
5. Click Save.

Related Topics
• Preview an Answer

Add a URL Answer  
When you create a URL answer, an external URL address displays to customers on the customer portal.

When customers click the URL, an external web page opens in a new window. URL answers are also indexed as
searchable text on the customer portal. You can still dene many of the same answer elds as in HTML answers.
However, some elds (such as the Question and Answer elds) are unavailable when adding a URL answer. The exact
elds available depend on the permissions set in your prole.

1. Do one of the following:

◦ Click New.

◦ If your navigation set is congured to add answers from the le menu, click File and select Answer.

2. Enter a one-line summary in the Summary text box.
This eld displays as the subject of the answer on the customer portal.

3. Select URL.
The Conrm Answer Type Change window opens.

CAUTION:  Use caution when you change the answer type of an existing answer. Some elds are
removed and cannot be restored (for example, the Question and Answer elds when changing from an
HTML answer to a URL answer).

4. Click Yes in response to the Conrm Answer Type Change message.
5. Enter or paste a URL address in the URL eld.
6. Click Preview to display the URL content.

The Preview section displays the link as it will appear in the customer’s web browser. It can also display other le
types or folder content.
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Note:  URL answers are not agged as updated on the Answers page when the answer content
changes if the URL does not change.

7. Click Save.

Add a File Aachment Answer  
You can add le aachment answers to link to information contained in another document.

File aachment answers contain many of the same answer elds as in HTML answers. However, some elds (such as
the Question and Answer elds) are unavailable when adding le aachment answers. The exact elds available depend
on the permissions set in your prole. You can aach only one le for each answer. File aachment answers are also
indexed as searchable text on the customer portal.

Note:  File aachment answers appear to customers on the customer portal as le aachments, which
is dierent than HTML answers that contain le aachments within the answer to provide additional
information.

1. Do one of the following:
◦ Click New.

◦ If your navigation set is congured to add answers from the le menu, click File and select Answer.
2. Enter a one-line summary in the Summary text box.

This eld will display as the subject of the answer on the customer portal.
3. Select File Aachment. The Conrm Answer Type Change window opens.

a. Click Yes.

CAUTION:  Use caution when you change the answer type of an existing answer. Some elds are
removed and cannot be restored (for example, the Question and Answer elds when changing from an
HTML answer to a le aachment answer).

4. Click Add File.
After you aach a le, information about the selected le appears on the Content tab. The Content tab contains
a paper clip icon when there is a le aached to the le aachment answer.

Field Description

Name This eld displays the name of the le.

Size This eld displays the size of the le.

Created This eld displays the date and time the le was created.

Updated This eld displays the date and time the le was last updated.

Description This eld displays the description of the le dened on the Properties window. You can
add or edit the description by selecting the le, clicking Properties and entering the
description in the Description eld.

Private This eld displays the visibility of the le aachment answer.

Action After a le has been added to the list, the Open, Download, and Delete options are
available.
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5. To open the aachment, click Open.
6. To download the selected le, click Download.

You are prompted to save the le aachment to the location you specify. A File Download window opens
displaying the download progress.

7. To change the display of the name and description, click Properties.
8. To remove this le from the answer, click Delete.
9. Click Save.

Related Topics
• Overview of the Aachments Tab

Edit an Answer  
You can edit answers, including sibling, manually related, and learned links.

When you edit an answer, you can also change the information in related answers, but keep in mind that editing
answers can aect other answers associated with it. You can also edit multiple answers at one time.

Tip:  You can also edit answer versions. See Answer Versioning.

1. From an answer report, right-click the answer and select Open.
2. To change the answer type, select the option next to the answer type.

CAUTION:  When you change the answer type in an existing answer, all answer relationships and
certain answer elds are removed. Use caution when changing an answer type.

3. Edit the answer elds.
4. To search the answer for a word or phrase to replace, click Find Text on the HTML toolbar.

The Find and Replace window opens. You can search for a word or phrase using case sensitive or whole word
only search criteria.

5. Edit the elds on each of the answer record tabs.
6. To notify answer subscribers of the change, click the Details tab.

a. Click Notify Subscribers.
b. Select one of the following options:
◦ No Change

◦ Do Not Notify

◦ This Hour

◦ End of Today

◦ End of this Week

◦ End of this Month
7. Click Save.

Related Topics
• How You Add Answers for Multiple Interfaces

• Other Answer Actions
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Associate Products and Categories to an Answer  
You can associate products and categories with answers. By associating products and categories with your answers, you
can create rules and facilitate searching.

1. From an answers report, right-click the answer and select Open.
2. Click the Products/Categories tab.

3. Select products and categories to associate with the answer.

Note:  Regardless of whether product linking is enabled and regardless of what categories are linked
to products, all products and all categories are available on the Products/Categories tab when you add
or edit an answer. In addition, product and category values are shared among sibling answers. When a
product or category is changed for an answer, it is also changed for that answer’s sibling answers.

4. To associate the answer exclusively with a product or category (without any dependence on subproducts or
subcategories), right click the product or category name.
The associated check box displays green and any parent products or categories display a gray check mark to
signify they are associated with the answer as well.

Related Topics
• Sibling Answers

Add or Edit a Task for an Answer  
You can add and edit all tasks associated with an answer by clicking the answer Tasks tab.

When you add or edit a task, you not only dene its name, the sta member it is assigned to, relevant dates, and type
of task, but you also associate it with new or existing answers. For more information on working with answer tasks, see
Answer Tasks Tab Toolbar.

1. Right-click the answer and select Open.
2. Click the Tasks tab.
3. Choose one of these options:

◦ Click Add and select Add New to open a new task on a subtab.

◦ Click Add and select Add Existing to open an existing task on a subtab.

◦ Right-click a task on the Tasks tab and select Open.
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4. Enter the task name in the Name eld.
5. To enter additional task information, complete the elds or select a menu option.
6. Click OK.

Related Topics
• How You Search from Open Records

• Add a Task

Add Answer Details  
The Details tab contains information associated with the selected answer. You can use the Details tab to control the
display position on the customer portal, notify subscribers of changes to the answer, and dene the review and publish
dates for the answer.

1. Enter eld information.

Field Description

Display Position* Click this drop-down menu to determine the answer display position on the customer
portal.

Historical Usefulness Select this option to use customer feedback to adjust the ranking of the answer.

Place at Boom Select this option to place the answer at the boom of the list by changing the score
to be equal to the lowest answer score. The score is then adjusted as the solved count
changes over time.

Place at Middle Select this option to place the answer at a level that is 50% of the highest answer score.
The score is then adjusted as the solved count changes over time.

Place at Top Select this option to place the answer at the top of the list on the Answers page by
changing the score to be equal to the highest answer. The score is then adjusted as the
solve count changes over time.

Fix at Boom Select this option to permanently x the answer at the boom of the list on the Answers
page by changing the score to be equal to the lowest answer score. The answer score
will not increase or decrease over time.
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Field Description

Fix at Middle Select this option to permanently x the answer at a level that is 50% of the highest
answer score. The answer score will not increase or decrease over time.

Fix at Top Select this option to permanently x the answer at the top of the list on the Answers
page by changing the score to equal the highest answer score. The answer score will not
increase or decrease over time.

Review On Click this drop-down menu to access a calendar and select a date to set the answer to
the Review status. Use the left and right arrows at the top of the calendar to select the
month, and then click a day.

Guided Assistance Click this buon to open the Select a Guide window, which lets you select a guided
assistance guide to associate with the answer.

Note:  The Guided Assistance buon does not display unless your
administrator has enabled guided assistance.

Notify Subscribers Click this drop-down menu to select an option for notifying subscribers when the
answer is updated. Options include Do Not Notify, This Hour, End of Today, End of This
Week, and End of This Month.

Publish On Click this drop-down menu to access a calendar and select a date to publish the answer.
Use the left and right arrows at the top of the calendar to select the month, and then
click a day.
On the selected date, the answer status will change to Public, and the answer is available
to customers. When an answer status is set to Private, the Publish On date is cleared.
 

Insert a Hyperlink  
You can create a hyperlink in an answer that will link to a URL.

When customers view an answer on the customer portal that contains a hyperlink, they can click the link and be directed
to either an internal or external URL.

1. From an answer report, right-click the answer and select Open.
2. Click the Link icon on the toolbar.

The Link window opens.
3. Enter eld information.

Field Description

Link Info Select this tab to dene your URL display and protocol options.

Display Text Enter the text you want to display as the link in this eld. If this eld is left blank, the URL
in the Link eld displays to customers.

Link Type Click this drop-down menu to select the type of link.

◦ URL—Adds a link to an external web page. This option is selected by default.
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Field Description

◦ Link to anchor in the text—Adds a link to an answer. To enable this option, you
must rst add an anchor to the answer. See Insert an Anchor.

◦ Email—Adds an email link to the answer content. Selecting this option lets you
create a message that is addressed to the specied email account.

◦ Phone—Lets you add a phone number to the answer content.

Protocol Select a protocol. Options include the following:

◦ hp://

◦ hps://

◦ ftp://

◦ news://

◦ <other>

*URL Enter a valid URL for the page you want to link to. To verify that the URL you typed is
accurate, click the View URL buon (to the right of the Link eld). A web browser opens
to the URL you specied. If you enter an invalid URL, an error message opens.

CAUTION:  If the link is to a non-HTML page (for example, a le type), a
security warning opens. Verify that the link is directed to a trusted source
before you click the Yes buon to continue.

Target Click the Target tab to dene target options.

Target Click the Target tab and then click the Target drop-down menu to select one of these
options.

◦ <Frame>—Enter the target frame name.

◦ <Popup Window>—Enter the window name, select window features, and enter
window size and position aributes.

◦ New Window (_blank)—The URL opens in a new window.

◦ Topmost Window (_top)—The URL opens in the top (focus) window.

◦ Same Window (_self)—The URL opens in the same window.

◦ Parent Window (_parent)—The URL opens in the same frameset.

Advanced Click the Advanced tab to dene options such as ID, language direction and code, and
stylesheet usage.

4. Click OK to insert the hyperlink at the cursor position in the current answer.

Add or Remove Hyperlink Underlines  
If you want your hyperlink to display an underline, you must add the underline text decoration manually, before you add
your hyperlink. If you want to remove the underline from your hyperlink, you must delete the underline text decoration
in source mode.

Even though the HTML editor for answers displays an underlined link when you create a hyperlink, the underline does
not display on your customer portal page. This is because the standard customer portal theme does not include a
hyperlink that displays with the underline text decoration. Instead, the hyperlink displays in plain text. However, when
you hover over the link, then an underline displays.
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Tip:  Keep in mind that answer links also display on the customer portal without the underline text decoration.
Therefore, if you want your answer links and your hyperlinks to look the same, make sure to apply consistent
formaing to both link types.

You can add the text decoration in design mode or source mode. Removal of the text decoration is available only in
source mode.

1. From the HTML editor for answers, click the Answer tab.
2. To add the underline text decoration to your hyperlink in design mode, enter the text you want to display as the

link.
a. Select your text and click the Underline icon on the toolbar.
b. Select your text again and then click the Link icon to dene your hyperlink options.

3. To add the underline text decoration to your hyperlink in source mode, click the Source icon on the toolbar. The
editor changes from design mode to source mode.

a. Add "style="TEXT-DECORATION: underline" to your hyperlink in the HTML.
4. To remove the underline text decoration from your hyperlink, click the Source icon on the toolbar. The editor

changes from design mode to source mode.
a. Delete "style="TEXT-DECORATION: underline" from your hyperlink in the HTML.

Related Topics
• Dening Themes

• Add an HTML Answer in Design Mode

• Add an HTML Answer in Source Mode

• Insert a Hyperlink

Insert an Image  
You can insert an image that is accessible through a URL in your HTML.

You can also dene the size of the image, its border properties, and alignment.

Note:  Copy and paste functionality is not available when inserting images into answers. Therefore, all answer
images must be referenced by URL. As a best practice, we advise you to host your les and graphics on your
own web servers and link to those les (through a HTTP address) within your answer content. For information
about storing images, see  Answer ID 4161  on our customer support site.

1. From an answers report, right-click the answer and select Open.
2. Click the Image icon on the toolbar.

The Image Properties window opens.
3. Enter eld information.

Field Description

*URL Enter the URL where the image is located.

Alternative Text Enter the alternate text for the image.

Width Enter the width, in pixels, you want the image to appear.
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Field Description

Height Enter the height, in pixels, you want the image to appear.

Border Enter the width, in pixels, of the image border.

4. Click OK.

Insert a Table  
You can insert a table in your HTML answer and dene the number of rows or columns and its border properties, cell
padding, and cell spacing.

1. From an answers report, right-click the answer and select Open.
2. Click the Table icon on the toolbar.

The Table Properties window opens.
3. Enter eld information.

Field Description

Rows Enter the number of rows in the table.

Columns Enter the number of columns in the table.

Width Enter the width of the table in pixels, or append a valid unit.

Height Enter the height of each row in pixels, or append a valid unit.

Headers Choose None, First Row, First Column, or Both.

Border size Enter the width, in pixels, of the table border.

Cell spacing Enter the spacing, in pixels, of the table cells.

Cell padding Enter the padding, in pixels, of the table cells.

Alignment Choose Left, Center, or Right.

Caption Enter the title of the table.

Summary Enter information about the table (not displayed).

4. Click the Advanced tab to choose the language direction and style sheet usage.
5. Click OK.

Insert an Answer Link  
You can create a link in an answer that references an existing answer. Service provides you with the exibility to easily
create links to existing answers by using the answer ID number instead of entering a long URL for the answer.

1. Right-click the answer on the content pane and select Open.
2. Click the Answer Link icon on the toolbar.

The Answer Reference Tag window opens.
3. Enter eld information.
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Field Description

*Answer ID Enter the answer ID of the answer you want to link to.

Link Text Enter the text you want to appear to customers.

Note:  If this eld is left blank, "Answer Link" displays to customers.

Title Enter the text you want to appear to customers when they hover over the link title.

Target Select the target location where you want the contents of the link to display. Available
options include the following:

◦ New Window

◦ Same Window

◦ Parent Window

◦ Browser Window

Anchor Enter the anchor in this eld to link to a specic location in a long string of text in an
answer. This allows the customer to link to the exact location.

4. Click OK to insert the answer link at the cursor position in the current answer.

Related Topics
• Insert an Anchor

• Referencing an Answer (video)

Insert an Anchor  
When you insert an answer link, you can also insert an anchor in the answer you are linking to. The answer link will open
to a specic location within the answer.

For example, you might have an answer that contains several paragraphs of text, but the rst paragraph does not
contain information that will answer the customer’s question. Using an anchor, you can quickly link to a specic
location.

1. Right-click the answer on the content pane, then select Open.
2. Insert the cursor in the exact location of the answer to which you want to link.
3. Click the Anchor icon on the toolbar.

The Anchor Properties window opens.
4. Enter a name for the anchor in the Anchor Name eld.
5. Click OK to add the anchor at the cursor position in the answer.
6. To rename an anchor, double-click the anchor to open the Anchor Properties window.
7. To delete an anchor, right-click the anchor and click Delete.

Related Topics
• Referencing an Answer (video)
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Insert a Variable into an Answer  
Answer variables are predened shortcuts for entering information into an answer instead of a long string of text.

When an answer is displayed on the customer portal, the variable is replaced with whatever value was specied by your
administrator.

Variables are also helpful to use for information that may change. When your administrator changes the value of the
variable, all answers containing that variable will also change. Contact your administrator for a list of variables dened
for your application.

For example, if your administrator added a variable for a support email address at your organization called “contact,”
you could insert the variable for the email address in the answer, such as $contact. If the email address changes, all
answers containing the contact variable are updated.

1. From an open answer, enter a dollar sign $ followed by the variable name.

Note:  Because variables are case sensitive, you must enter the variable name exactly as it is dened.
See Add or Edit a Variable.

The assigned value displays when customers view the answer.

Associate an Answer with Multiple Access Levels  
You can associate multiple access levels with an answer.

If any of the access levels have customer visibility, the answer is visible on the customer portal. In addition, you can
control the answers returned in a customer’s search by assigning them SLAs that allow privileged access to specic
answers. For example, a customer assigned an SLA with Gold access is able to view all answers with the assigned access
levels of Gold, Everyone, or Gold and Everyone.

Access levels are just one way of controlling answer visibility. For information about other ways to control answer
visibility, see How to Control Answer Visibility.

1. Right-click the answer on the content pane and select Open.
2. Click Access Level and select the check box next to each access level you want to assign to the answer.

3. To view the answer as customers will see it on the customer portal, click the Quick Preview tab.
4. Click Save.

Insert a Conditional Section  
Conditional sections control the visibility of specic sections within your answers, allowing customers with only the
appropriate service level agreement (SLA) to view the conditional sections.

One scenario for using conditional sections is when you are working on an answer and you want to add information that
is not yet approved for public visibility. You can create an access level that has no customer portal visibility and assign it
to the conditional section you do not want customers to view.
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Conditional sections can also be used with privileged access levels assigned to specic SLAs. Those customers assigned
an SLA with a privileged access level are able to view the conditional sections assigned to the privileged access level. For
example, a customer assigned an SLA with Gold access is able to view conditional sections with access levels of Gold,
Everyone, or Gold and Everyone. This provides more exibility to customize and personalize answers for customers.

Tip:  Conditional sections can also be nested. Although answers allow unlimited nesting levels, we strongly
recommend that you limit the nesting levels to three inner sections.

1. Right-click the answer on the content pane and select Open.
By default, the Question tab is active.

2. To add your conditional section to the answer portion, click the Answer tab.
3. Click the Conditional Section icon on the toolbar.

The Access Levels window opens.
4. Select the access levels you want to assign to the conditional section.
5. Click OK.

The Conditional Section text box displays on the Answer tab.

When conditioning a section of an answer with an access level not associated with the answer, the section will
never be visible to customers.

6. Enter the information in the Conditional Section text box.
7. Click Save.

Modify Conditional Sections  
Follow this procedure to modify a conditional section.

1. Right-click the answer on the content pane and select Open.
By default, the Question tab is active.

2. Click the Answer tab.
3. To edit the text of a conditional section, click the conditional section and enter your text in the Access Level

Conditional text box.
4. To nest a conditional section in the current conditional section, click inside the answer section and then click

the Conditional Section icon on the toolbar. See Insert a Conditional Section.
5. To change the access level of a conditional section, double-click the conditional section to open the Access

Levels window.
a. Select the access level or multiple access levels.
b. Click OK to assign the selected access levels and close the Access Levels window.

6. Click Save.
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If the answer contains conditional content and the customer has access to that level of privileged answer, the
conditional content is visible on the Answers page. You can see how the answer will appear to customers with dierent
access levels on the customer portal using the Preview functionality.

Related Topics
• Edit the Search Results Page

• Preview an Answer

Append Answer Content  
While editing an answer, you can search for other answers in the knowledge base. If answers are returned that match
your search criteria, you can append them to the answer you are editing.

The Search Knowledge Base window contains this tab set:

• Answers—Contains links to answers in the knowledge base that match your search phrases.

• Search Priority Words—Contains links to answers in the knowledge base that correspond to search priority
words in Service. See Overview of the Answer and Question Details Pages.

1. Right-click the answer on the content pane and select Open.
2. Click the Search icon on the toolbox.

The Search Knowledge Base window opens.

3. Enter your search criteria and click Search.
4. Click the Answers tab.

◦ To append an answer link to the answer you are editing, click Add as Link next to the answer. The answer
title and a link to the answer are appended to the selected eld of the answer at the cursor position.

◦ To append the answer text to the answer you are editing, click Add as Text. The text of the answer is
appended to the answer at the cursor position.

◦ To view the answer, click View.

5. Click the Search Priority Words tab.
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◦ To append an answer link to the answer you are editing, click Add as Link next to the answer. The answer
title and a link to the answer are appended to the selected eld of the answer at the cursor position.

◦ To append the answer text to the answer you are editing, click Add as Text. The text of the answer is
appended to the answer at the cursor position.

◦ To view the answer, click View.

6. To view the answer as it will appear on the customer portal, close the Search Knowledge Base window and
click the Quick Preview tab.

7. Click Save.

Related Topics
• Preview an Answer

Preview an Answer  
Before making an answer available to customers, you can preview it on the customer portal to ensure everything is
accurate.

You can verify that the answer and answer sections appear as you anticipated by viewing the answer with dierent
access levels selected. See How to Control Answer Visibility.

Note:  Customer portal themes are not applied when previewing answers on the content pane. This means
the way your answer displays in the preview may be dierent from how it displays on the customer portal. We
recommend using the cascading style sheet (CSS) from your customer portal when previewing answers.

1. From an answers report, right-click the answer and select Preview Answer.
2. Select the access levels from the Access Level drop-down menu.

Only the sections of the answer with the selected access level will appear on the Answer Preview window.
3. Click Preview.

Related Topics
• What to Do When Answers Are Not Visible

• Dening Themes

• Use the End-User Cascading Style Sheet in Answer Previews

Use the End-User Cascading Style Sheet in Answer Previews  
You can use the cascading style sheet (CSS) from your customer portal when previewing answers, to get a beer idea of
how they will look to the end user. To do this, you must modify the standard answer workspace.

The end-user CSS from the customer portal is also applied to the content when editing the Question and Answer
content in the HTML editor.

Note:  The Service Console uses custom code and seings to render previews; therefore the appearance of an
answer in a preview will not be exactly as on your customer portal.
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1. Copy the standard answer workspace, then open the copy for editing.
2. Click the Design tab.
3. On the Content tab in the workspace, click the Answer Type Container control.
4. On the Design tab, select the Apply End User CSS check box.
5. Save the modied workspace.

Edit the proles of sta members to use the modied workspace. See Add or Edit a Prole.

Validate Links in an Answer  
You can check for broken links in HTML and URL answers.

This functionality applies to hyperlinks and links to other answers. The broken links checker functions on a per-answer
basis. When validating an HTML answer, the broken links checker scans text on the Question and Answer tabs. When
validating a URL answer, the broken links checker scans the URL eld.

1. While editing an answer, click Check Links.
The Check Links window opens and link validation begins.

Column/Buon Description

Name This column displays the name of the links that have been checked for validity. If a link
does not have a name, this column is empty. Because links in URL answers do not have
names associated with them, this column is empty for all URL answers.

Target This column displays the links that have been checked for validity. Hyperlinks open in a
new browser, whereas answer links open on the Answer Preview window.

Status This column displays the status of the links. The following statuses display depending
on the type of link being validated.
Valid—This status is used only for hyperlinks and signies that the links checker
successfully visited the link destination.
 
Broken—This status is used only for hyperlinks and signies that the links checker
aempted to visit the link destination, but was unsuccessful.
 
Does Not Exist—This status is used only for answer links and signies that the links
checker did not nd the answer ID in the knowledge base.
 
Public Status Type—This status is used only for answer links and signies that the
answer was found in the knowledge base and is associated with a Public status type.
 
Private Status Type—This status is used only for answer links and signies that the
answer was found in the knowledge base and is associated with a Private status type.
 

Action This column displays the actions that can be performed on the link. Currently, Edit is the
only action available.

Status Bar The status bar shows the progress of the validation process. It is not an indicator of the
validity of the links. Rather, it is an indicator of the number of links being validated by
the links checker.
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Column/Buon Description

Revalidate Click this buon to restart the validation process for all links displayed on the Check
Links window.

2. To edit a link, click Edit in the link’s Action column.
If you are editing a hyperlink, the Edit Hyperlink window opens. If you are editing an answer link, the Edit
Answer Link window opens.

Note:  Although you can update elds (such as changing the Target eld), you cannot leave a eld
blank. If a link does not have a name associated with it, the Name eld is disabled.

3. Enter your changes in the appropriate elds.
4. Click OK.

The Edit Hyperlink or Edit Answer Link window closes and all links are automatically revalidated and
displayed on the Check Links window.

5. Click OK on the Check Links window.
The Check Links window closes.

Edit a Related Answer  
You can edit related answers, including sibling, manually related, and learned links.

Editing a related answer will aect all answers associated with it.
1. From an answers report, right-click the answer and select Open.
2. Click the Relationships tab.
3. Click Open next to the answer you want to edit.

The related answer opens in a new window.
4. Enter your changes.
5. Click OK.
6. Click Save.

Merge Similar Answers  
You can eectively manage the answers in your knowledge base by merging similar answers or merging the content of
one answer with another answer.

In addition, merging answers also merges any conditional sections. Conditional sections display as text in the
appropriate elds of the answer. See Insert a Conditional Section.

Answers can be merged with similar answers found in the knowledge base using the Smart Merge feature. Smart Merge
helps you to identify similar answers and merge them. Merging answers provides your customers with more complete
information and can help you eliminate duplicate answers.

Note:  Smart Merge relies on the conguration seings used for the SmartAssistant feature. Changing these
conguration seings may change the weight given to the relevant answers displayed for both Smart Merge
and SmartAssistant. See Modify SmartAssistant Relevancy.

1. Right-click the answer on the content pane and select Open.
2. Click the Smart Merge icon (next to the Search icon) on the toolbar.

1044



Oracle Service Cloud
Using Service Cloud

Chapter 5
Service

3. Enter eld information.

Field Description

Parent Answer The parent answer is the current answer to which you are merging an answer. This eld
displays the summary of the open answer.

Include in Search Dene your search criteria with any of these areas of the answer. All options are selected
by default.

Summary Select this check box to search the Summary eld for answers you can merge.

Keywords Select this check box to search the Keywords eld for answers you can merge.

Question Select this check box to search the Question eld for answers you can merge.

Answer Select this check box to search the Answer eld for answers you can merge.

All Select this option to return all answers, regardless of status.

End-User Visible Select this option to return only public answers.

4. Click Refresh.
The results display on the Smart Merge window. The matched answers are sorted by relevance.

5. Click Action next to each answer you want to merge, and select from the merge options.

Option Description

Merge Select this option to merge the answer with the answer you are editing.

Merge and Make Private Select this option to merge the answer with the answer you are editing and set the
status to Private. A warning prompts you to verify the action.

Merge and Delete Select this option to merge the answer with the answer you are editing and then delete
the answer after it has been merged.

CAUTION:  Selecting this option permanently deletes the selected answer
from the knowledge base. Use caution when selecting this option.
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Option Description

Show Select this option to view the answer in a separate window before you merge it with the
answer you are editing.

Cancel Select this option to cancel the current selection.

Tip:  After you select an option, the underlined text next to the answer changes. For example, if you
select Merge, the text changes from Action to Merged.

6. Click Close to close the window and return to the answer.
7. To view the merged answer as it displays on the customer portal, click the Quick Preview tab.
8. Click Save.

Related Topics
• Preview an Answer

Delete an Answer  
You can delete answers from Service when they become outdated.

However, use extreme caution when deleting answers because deleting an answer will also delete all associated
relationships.

CAUTION:  Deleting is permanent and cannot be undone.

1. Right-click the answer on the content pane and select Delete.
2. Click Yes to delete the answer.

Answer Versioning  
You can create new versions of answers, while keeping previous versions as historical versions.

Note:  Before you can use answer versioning, you must modify the standard answer workspace.

Answer versioning lets you do the following:

• Draft new versions of existing answers, including from historical versions.

• Publish new answer versions immediately or at a designated time in the future.

• Compare answer versions.

• Delete answer versions.

• Audit answer versions.
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Answer IDs and version IDs are independent from each other. The IDs may or may not have the same numbers when
the versions are created. For information on which answer elds are versioned, see Versioned Answer Fields

Tip:  If you plan to audit answer versions, we recommend creating business rules to prevent answer versions
from being deleted.

Versioned Answer Fields  
If you edit a versioned eld, it changes only for the version that you edited. This table lists the elds that are versioned
in answers.

Field Table Column Description

Access Level access_id Access level for the answer

Access Mask access_mask Indicates the access levels for the answer through a bitmap

Answer solution Solution eld of the answer

Assigned assgn_acct_id Sta member to whom the answer is assigned

Assigned Group assgn_group_id Sta group to which the answer is assigned

Date Updated updated Date and time when the answer was last edited

Draft Date v$drafted Date and time when the draft was created

Draft Note v$draft_note Note for the answer version when the draft is created

Expiration Date expires Date when the answer status will automatically be set to Review

Keywords keywords Keywords eld in the answer

Last Edited By last_edited_by ID of the last sta member to edit the answer

Notes notes Notes associated with the answer

Parent Version ID v$parent_version_id ID of the version from which the version was drafted

Publish Date v$published Date and time when the answer version was published

Publish Note v$publish_note Note for the answer version when it is published

Publish On publish_on Date when the answer status will automatically be set to Public

Question description Question eld of the answer

Status status_id Current status of the answer, such as Private or Public

Status Type status_type Type of the answer status

Summary summary Summary of the answer content

URL url URL associated with a URL answer

Unpublish Date v$unpublished Date and time when the answer version was changed to the Historical state

Version ID v$id Unique ID number of the version
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Field Table Column Description

Version State v$state State of the answer version: Draft, Live, or Historical

Nonversioned Associated Objects and Answer Fields  
If you edit a nonversioned eld or object from an answer or answer version, it changes for that answer and all versions
of that answer. These lists include elds and associated objects that are not versioned in answers.

Nonversioned Objects Associated with Answers
The following objects are not versioned.

• Custom elds

• System aributes

• Related objects:

◦ Aachments

◦ Notes

◦ Products and categories

◦ Tasks

Nonversioned Answer Fields
The following elds are not versioned.

Field Table Column Description

Admin Long-term
Score

ault_solved_count Long-term solved count for administrative users

Admin Short-term
Score

aust_solved_count Short-term solved count for administrative users

Answer ID a_id Unique ID number of the answer

Answer Type type Type of the answer: HTML, URL, or File Aachment

Banner Account banner_acct_id Sta account that last updated the ag

Banner Flag banner_ag Importance of the ag

Banner Text banner_text Text added to the ag

Computed Score solved Answer score

Date Admin Last
Access

admin_last_access Date and time a sta member last opened the answer while editing an incident

Date Banner Flag
Last Updated

banner_upd Date and time the ag was last edited

Date Created created Date and time the answer was created

Date Last Access last_access Date and time the answer was last viewed from the end user pages
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Field Table Column Description

Date Last Notify last_notify Date and time a notication was last sent for the answer

End-User Short-
term Score

eust_solved_count Customers' short-term solved count for the answer

Escalation Date escldate Date and time that the answer is scheduled to be escalated, or the last time the answer was escalated
by answer rules

Escalation Level escllevel Escalation level of the answer

Guided Assistance
Guide

dt_id Guided Assistance ID for the answer

Language lang_id Language to which the answer is assigned

Meta-Answer ID m_id ID number of the meta-answer to which the answer is assigned

Next Notication next_notify Date and time the next answer notication will be sent for the answer, if the answer is modied before
the specied date and time

Position in List position Display position of the answer in the answer list

Rule State rule_state Rule state of the answer

Score solved_count Solved count for the answer. This is a measure of how helpful the answer is to end users.

Static Score static_solved Static score assigned to the answer. The static score overrides the solved count and is used to
determine the answer display position.

Create an Answer Workspace for Answer Versioning  
You must modify the standard answer workspace to enable answer versioning.

Answer versioning uses the Answer Versions report located in Public Reports/Service/Views - Service/Editor
Reports - Service.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces. (If workows are enabled, the item is

labeled Workspaces/Workows.)
The Workspaces explorer opens on the content pane.

3. Copy the standard answer workspace and name the copy.
4. Open the new workspace for editing.
5. Add the Draft and Publish buons to the ribbon.

a. Click the Home tab, and then click Ribbon.
b. In the Ribbon Designer, click any of the buons in the Actions section of the Ribbon Preview.

The editing window displays the buons in the Actions group.
c. Click Add Buons.
d. In the Add or Remove Buons window, select the Draft and Publish check boxes, and then click OK.
e. Use the arrows to move the Draft and Publish buons where you want them to be located.
f. Click OK to close the Ribbon Designer.

6. Add a new tab to the workspace and name the tab Versions.
7. Add the Answer Versions report to the new tab.

a. Click the Insert Control tab, and then drag and drop a Report control onto the Versions tab.
b. Click the Design tab, and then click Report.
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c. In the Select Report window, select  Public Reports > Service > Views —Service > Editor Reports —
Service > Answer Versions , and then click OK.
The Answer Versions report is added to the Versions tab.

8. Click the Insert Field tab, and then add the following elds above the report.

◦ Version ID

◦ Parent Version ID

◦ Version State

◦ Draft Date

◦ Draft Note

◦ Publish Date

◦ Publish Note

◦ Publish On (optional: this eld is already on the Details tab)

◦ Review On (optional: this eld is already on the Details tab)

9. Click Save.
10. Edit the proles of any sta members who need to create answers so they can use the new workspace.

The new answer workspace should resemble this:

Related Topics
• Add Tabs to the Design Space

• Copy a Workspace

• Edit a Workspace

Create a New Answer Version  
You use the modied answer workspace to create a new draft from an answer, then publish it.

This procedure assumes that the answer workspace has been modied to enable answer versioning.
1. Open the answer for which you want to create a new version.
2. Click Draft.
3. In the Create Draft window, enter a note for the draft, then click OK.

The default note is: Draft created from version id: current_version_number .
The new version opens in an answer editor, with  - Draft appended to the title.

4. Close the editor for the previous version.
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5. Edit the new version, then click Save.
Clicking the Versions tab shows that the original answer version is in the Live state, while the new version is in
the Draft state.

6. To publish the draft immediately:
a. Click Publish. The Publish Draft window opens.
b. Enter a note about the draft, and then click OK.

The default note is: Publish draft with version Id: new_version_number .
The draft is published. The Versions tab shows that the original version is now in the Historical state,
while the new version is in the Live state.

7. To publish the draft on a future date, click the Calendar icon next to the Publish On eld.
a. Select a publishing date.

If a draft is already set to publish, the Publish On window opens with the draft version ID and the
scheduled publish date.

b. Click OK.
c. Click Save. The draft is published on the specied date.

Note:  If you change your mind about publishing your draft, you can clear the Publish On eld.

Create a New Answer Version from a Historical Version  
You can create a new draft from a historical version of an answer. For example, you might want to revert some of the
changes that have been made to the answer. You can also use this procedure to create a draft from another draft.

1. Open the answer for which you want to create a new version.
2. Click the Versions tab.
3. Double-click the historical version.

The historical version opens in a new answer editor, with  - Historical appended to the title.
4. Close the editor for the live version.
5. Click Draft in the new editor.
6. In the Create Draft window, enter a note for the draft, and then click OK.

The default note is: Draft created from version id: historical_version_number .
The new version opens in an answer editor, with  - Draft appended to the title.

7. Close the editor for the historical version.
8. Edit the new version, and then click Save.

Clicking the Versions tab shows that the original answer version is in the Historical state, while the new version
is in the Draft state.

9. To publish the draft immediately, click Publish.
a. In the Publish Draft window, enter a note about publishing the draft, and then click OK.

The default note is "Publish draft with version Id: new_version_number."
The draft is published. Clicking the Versions tab shows that the original and previously live versions are
now in the Historical state, while the new version is in the Live state.

10. To publish the draft on a future date, click the Calendar icon next to the Publish On eld.
a. Select a publishing date from the calendar.

If a draft is already set to publish, the Publish On window lists the draft version ID and the publish date.
b. Click OK.
c. Click Save.

The draft is published on the specied date. Clicking the Versions tab shows that the original answer
version is still in the Historical state, while the new version is in the Draft state.
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Compare Answer Versions  
You use the answer preview functionality to compare versions. For example, you might want to compare the live version
to a historical version.

1. Click the Versions tab, and then select the rst version to compare.
2. Click Preview.

The answer version displays in the Answer Preview window.
3. Click  File > Compare .
4. Select the answer version to compare to the rst version, and then click Select.

The two versions are compared side by side in the Answer Preview window.

Delete an Answer Version  
You can delete answer versions without deleting the entire answer.

Deleting the live version of an answer causes the answer to be lost temporarily from any report or functionality that
relies on it. Publishing a draft version restores that functionality.

However, you cannot delete the live version of an answer from the Service Console without deleting the answer (and all
of its other versions).

To identify answers that are missing live versions, run the Answers Missing Live Versions report, located in Public
Reports/Service/Views - Service/Editor Reports - Service).

1. In your modied answer workspace, click the Versions tab.
2. Select the row of the answer version you want to delete by clicking in the row.
3. Click Delete on the Versions tab, and then select Answer Version.

The Answer Version Delete window displays, with the following message:

Are you sure you want to delete this answer version? Note that any rule using this
answer version will need to be modified.

4. Click Yes.
5. Click Refresh.
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The answer version is deleted.

Answer Version Audit Log  
Use the Audit Log tab to view events that have occurred for answer versions. The audit log for answer versions is
especially useful in regulated industries.

The Answer Version Audit Log report, located in Public Reports/Service/Views - Service/Editor Reports - Service,
displays on the Audit Log tab.

Tip:  We recommend creating business rules to prevent answer versions from being deleted if you plan to
audit answer versions.

1. From an open an answer, click the Versions tab, and then open an answer version.
2. Click the Audit Log tab.

The following transactions are listed.

• For the answer

• That aect the answer and sibling answers

• For the answer version

Related Topics
• Audit Logs

Find the Live Answer Version For a Specic Date  
You can use the Answer Version Audit Search report to nd which version of an answer was live on a specic date. This
report can be especially useful in regulated industries.

This procedure assumes that the Reports Explorer component has been added to the Analytics buon in your
navigation set. The Answer Version Audit Search report is located in Public Reports/Service/Search Reports -
Service.

We recommend creating business rules to prevent answers from being deleted if you plan to audit answer versions. In
the current release, you cannot delete answer versions without deleting the entire answer.

1. Click Analytics on the navigation pane, and then double-click Reports Explorer.
2. Expand  Public Reports > Service > Search Reports — Service , and then double-click Answer Version Audit

Search.
You can also add this report to the Answers buon in your navigation set.

3. In the Search window, enter the answer ID.
4. Click the Calendar icon to enter a search date or timeframe.

The Relative check box is selected by default, with zero (0) months rounded for the date.
5. (Optional) Deselect the Relative check box to provide a specic date.
6. Click Search.

The search result displays, as shown in this example.

You can open the version in the search result from the report.
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Answer Relationships  
You can relate one answer to other answers that contain similar content.

This functionality also provides a way for you to group similar answers, improving the way you keep track of and update
answers in your knowledge base. Answer relationships can be managed on the answer Relationships tab. The answer
relationship types available to you depend on how the answer workspace assigned in your prole is customized. When
two or more answers are related, you can view the relationship from the Relationships tab of any of the answers.

Sibling, manually related, and automatically related answers are displayed on the Relationships tab. The tab is divided
into these sections.

• Sibling Answers—Answers that can share the same product, category, or le aachments

• Manually Related Answers—Two or more answers manually dened by a sta member

• Learned Links—Answers that have learned relationships as a result of customer activity

Manually related and learned links are disabled when the answer type is set to either URL or File Aachment.

Regardless of which types of answer relationships you work with, it is important to note that all relationships between
answers are at a peer level and not at a subordinate level. For example, if you have three answers you want to relate (1, 2,
and 3), you can relate 2 to 1 and 3 to 2. All three answers are peers, including answers 1 and 3.

Sibling Answers  
Sibling answers are those that can share the same product, category, or le aachments.

Sibling answers and aachments with access levels that are at or below the contact’s SLA are visible to the contact.

Note:  To display le aachments for answer siblings on the Aachments tab, the Siblings Visible property
for the File Aachments relationship item on the custom answer workspace must be set to True. See Options
Properties.

The Sibling Answers section of the Relationships tab consists of a toolbar and a list of sibling answers. The toolbar is
located above the sibling answer list.

1054



Oracle Service Cloud
Using Service Cloud

Chapter 5
Service

Buon Description

Add Click this buon and select one of these options.

Add New Select this option to add an answer and establish a sibling relationship between the current answer and
the new answer.

Add Existing Select this option to create a sibling relationship between the current answer and an existing answer.
The Answer Search window displays so you can search for an existing answer.

Open Click this buon to open the selected sibling answer.

Print Click this buon to print the selected sibling answer.

Delete Click this buon to delete the sibling answer.

Remove Click this buon to remove the selected sibling answer, which disables the answer relationship.

Preview Click this buon to preview the selected sibling answer.

Options Click this buon to display a drop-down menu of analytics options.

The list in the Sibling Answers section contains answers that share the same product or category as the current answer.

Column Description

Answer ID This column displays the ID assigned to the answer.

Summary This column displays a summary of the answer content. The summary is the answer subject.

Language This column displays the language of the answer.

Status This column displays the status of the answer.

Assigned This column displays the name of the sta member assigned to the answer.

Date Updated This column displays the date the answer was last updated.

Action This column displays a link for opening the sibling answer. Right-click the Open link to display Print,
 Remove, and Preview functionality.

Related Topics
• Record Search Options

Move an Answer to a Sibling Set  
Follow this procedure to move an answer to a sibling set.

1. From the Relationships tab, click  Add > Add Existing  on the Sibling Answers toolbar of the Relationships tab.
The Answer Search window opens.

2. Search for the answer you want to move to your sibling set and click Select.
The Move Siblings window opens.

3. Select the sibling set option you want to use.
4. Click OK.
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Remove an Answer from a Sibling Set  
Follow this procedure to remove an answer from a sibling set.

1. In the Sibling Answers section of the Relationships tab, select the answer that you want to remove from the
sibling set.

2. Click Remove.
The Move Answer window opens.

3. Select the appropriate option.
4. Click OK.

Manually Related Answers  
Manually related answers are two or more answers that might contain related information. Manually relating answers
provides customers with additional options for nding accurate information.

The Manually Related Answers section of the Relationships tab consists of a toolbar and a list of manually related
answers. The toolbar is located above the manually related answer list.

Buon Description

Add Existing Select this option to create a relationship between the current answer and an existing answer. The
Answer Search window will display so you can search for an existing answer.

Open Click this buon to open the selected answer.

Print Click this buon to print the selected answer.

Delete Click this buon to delete the selected answer.

Remove Click this buon to remove the selected answer from the list, which disables the answer relationship.

Preview Click this buon to preview the selected answer.

Options Click this buon to display a drop-down menu of Analytics options.

The list in the Manually Related Answers section contains answers that might contain related answer information.

Column Description

Answer ID This column displays the ID assigned to the answer.

Summary This column displays a summary of the answer content. The summary is the answer subject.

Action This column displays a link for opening the manually related answer. Right-click the Open link to
display Print, Remove, and Preview functionality.

Related Topics
• Record Search Options

Learned Links  
Service can automatically link answers based on customer activity. Relationships between answers are established when
customers view answers during the same visit.
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The Learned Links section of the Relationships tab consists of a toolbar and a list of learned link answers. The toolbar is
located above the learned links answer list.

Buon Description

Open Click this buon to open the selected answer.

Print Click this buon to print the selected answer.

Preview Click this buon to preview the selected answer.

Promote Click this buon to promote the learned link to a manually related answer. The answer is added to the
Manually Related list.

Block/Unblock Click this buon to block the answer from appearing in the Related Answers section on the customer
portal. To block more than one answer, press Ctrl while selecting each answer.
Click this buon again to allow a blocked answer to appear in the Related Answers section on the
customer portal.
 

Note:  Blocking or unblocking a learned link is eective only for the answer in which the
block was placed. Other answers where a particular answer appears as a learned link are not
aected.

Options Click this buon to display a drop-down menu of Analytics options.

The list in the Learned Links section contains answers that are related as a result of customer activity. All learned link
answers are listed.

Column Description

Answer ID This column displays the answer ID number.

Summary This column displays a summary of the answer content. The summary is the answer subject.

Blocked This column displays the blocked mode of the answer link on the customer portal. If No displays, then
the answer link is not blocked on the customer portal. If Yes displays, then the answer link is blocked on
the customer portal.

Action This column displays a link for opening the learned link answer. Right-click the Open link to display
Print, Remove, and Preview functionality.

Note:  If the Related Answers feature is enabled, learned links will appear in the Related Answers section on
the customer portal when a customer views the answer. The number of related answers (learned links) that
display depends on how your site is congured.
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Other Answer Actions  
Besides editing and adding answers, you might have other answer management duties, for example, printing an
answer, copying an answer, or making the same change to multiple answers.

• Printing answers—You can create a printable version of your answers. When using this function, the answer
opens in a new window. The print command is then launched through your web browser and you can choose to
print the contents of the page. See Print a Record.

• Copying answers—You can copy an existing answer to make a new answer or sibling answer. When copying
an answer, the language and access level are retained, but the status is set to Private to prevent you from
accidentally publishing it. See Copy a Record.

• Updating multiple answers—You can edit more than one answer at the same time and edit various elds such
as status, assigned sta member, review and publish on dates, products, categories, and custom elds. This
feature saves you time when you want to make the same change to multiple answers. See How You Update
Multiple Records.

Model Questions  
Using functionality in Oracle Service Cloud and Virtual Assistant, you can oer your customers a beer experience when
they search for answers by guiding them directly to the information they need.

Oracle RightNow Virtual Assistant Cloud Service (Virtual Assistant) uses best-in-class semantic search technology
combined with industry-specic linguistic dictionaries and advanced algorithms to ensure your customers’ questions
are matched to deliver the right answers immediately. Conguration options will not be visible until Virtual Assistant is
enabled. Contact your Oracle account manager.

From the Model Questions tab of a custom answer workspace or from the standard Answers Default report, you can link
answers in the knowledge base to model questions in Virtual Assistant.

Note:  Non-English languages are not supported when working with model questions.

Create a Custom Answer Workspace for Model Questions  
Custom answer workspaces let you use model questions with Virtual Assistant, which can improve your search results.

Before working with model questions, a custom answer workspace must be created and the Model Questions tab and
control must be added to the workspace.

This is not necessary if you are adding model questions from the Answers Default report, as the Model Questions buon
displays on the ribbon after Virtual Assistant is enabled.

1. Click Conguration on the navigation pane.
2. Double-click Workspaces under Application Appearance.

The Workspaces explorer displays on the content pane.
3. Expand the Standard folder, right-click Answer, and select Copy.

The Copy Answer As window opens.
4. Enter a name for the copied workspace in the Name eld and click OK.
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5. Open the copy of the answer workspace.
6. Right-click the Notes tab and select Add Tab Before.
7. Click the Design tab on the ribbon.
8. In the Label section of the ribbon, click Text and rename the tab Model Questions.
9. Click the Insert Control tab on the ribbon.

10. In the Relationship Items section of the ribbon, drag the Model Question control under the Model Questions tab
on the workspace.

11. Click Save.

Now you must update sta member proles by selecting the Model Questions check box on the Service tab of the
Permissions page. You must also assign this custom answer workspace to sta member proles.

Related Topics
• Proles

• How You Congure Virtual Assistant

• Add a Model Question from the Answers Default Report

• Service Permissions

Add a Model Question from an Existing Answer  
Model questions are linked to answers in the knowledge base and are displayed as similar questions on the Answers
page of the customer portal. You can add model questions from an existing answer.

1. Right-click an answer in an answers report and select Open.
The answer displays on the content pane.

2. Click the Model Questions tab.
3. Click  Add > Add New .

The Choose a Model Question Category window opens.
4. Click the category drop-down menu and select a leaf category.
5. Click OK.

The new model question and answer are added to the list.
6. Click Save.

IDs are assigned to the model question for association and validation purposes.

7. To remove the association between the answer in Oracle Service Cloud and the model question in Virtual
Assistant, select the model question in the list and click Remove on the toolbar or click the Remove link under
the Action column.

8. Click Save.
9. Log in to Virtual Assistant and validate the model question. This ensures that an association is made between

the answer in the Oracle Service Cloud knowledge base and the model question in the Virtual Assistant
database.
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Related Topics
• Virtual Assistant Documentation

Associate an Existing Answer with an Existing Model Question  
You can associate an existing answer with an existing model question.

1. Right-click an answer in an answers report and select Open.
The answer displays on the content pane.

2. Click the Model Questions tab.
3. Click  Add > Add Existing .

The Associate Existing Model Question window opens.
4. Enter a single-word value in the Search eld and click Search.

Wildcards are not supported when searching for model questions.

Note:  Searches are performed against only the Question eld (title) of model questions. To view the
Question eld for model questions, you must log in to Virtual Assistant.

5. Select one or more model questions to associate with the answer in Oracle Service Cloud.
6. Click Associate.

The model question is added to the list.
7. To remove the association between the answer in Oracle Service Cloud and the model question in Virtual

Assistant, select the model question in the list and click Remove on the toolbar or click the Remove link under
the Action column.

8. Click Save.
9. Log in to Virtual Assistant and validate the model question. This ensures that an association is made between

the answer in the Oracle Service Cloud knowledge base and the model question in the Virtual Assistant
database.

Related Topics
• Virtual Assistant Documentation

Add a Model Question from the Answers Default Report  
Follow this procedure to add a model question from the Answers Default report.

Before sta members can add model questions, the Model Questions permission must be enabled on the Service tab of
the Prole Permissions editor. See Service Permissions.

1. Open the Answers Default report located in Public Reports/Service/Views–Service/Answer Views.
2. Select one or more answers in the list.
3. Click Model Questions.

The New Model Question window opens, displaying the answer and its associated Virtual Assistant model
questions.
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4. Select the check box under the Create column to associate an answer with an existing model question.
If an answer does not have an existing model question association, the check box under the Create column is
selected by default to signify that a model question association will be made.

5. Click the category drop-down menu and select a leaf category.
6. Click Create Model Question.

The New Model Question window closes.
7. Click Save.
8. Log in to Virtual Assistant and validate the model question.

This ensures that an association is made between the answer in the Oracle Service Cloud knowledge base and
the model question in the Virtual Assistant database.

Related Topics
• Virtual Assistant Documentation

Content Library  

Overview of Content Library  
You can create standard text and variables to represent words, phrases, and replies that agents use frequently. Your
agents can use this content to save time and eliminate errors when responding to customers and creating answers.

Standard text can be inserted in incident responses or in chat sessions, or added as a business rule action, making
the information your organization presents more consistent. For example, you may want to create standard text
for commonly used information about your products and pricing, or to relay standard troubleshooting or contact
information to customers.

You can also assign a hot key to any standard text. Agents can use a hot key as a shortcut for inserting standard text
when working on incidents or engaged in a chat session.

Variables are shortcuts that can be inserted into incident responses, chat sessions, or in the Question and Answer
elds of an answer. For example, instead of agents entering your organization’s support phone number every time,
you can add the phone number as a variable. Agents can copy a variable and paste it or enter the variable inline when
responding to a customer in a chat session or an incident response. Variables can be indexed to make the answer
contents more searchable.

You can embed variables as shortcuts in standard text, including variables dened on the Variables editor or system-
dened variables. Variables are also helpful to use for information that may change. By updating the value of the
variable, you will also update all answers that contain that variable.

You can add folders to organize standard text and variables and organize folders in the tree.

Related Topics
• Add or Edit Standard Text

• Add or Edit a Variable

• Insert Standard Text from the Standard Text Window
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Add or Edit Standard Text  
Provide standard text that your agents can use to save time, eliminate errors, and respond with consistent information
in incident responses, chat sessions, and answers. You can also organize standard text using folders.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Standard Text.

The Standard Text tree displays on the left side of the content pane.
3. Choose one of the following options:

◦ To add standard text, click New.

◦ To edit standard text, select it in the tree.

Tip:  You can search for standard text by expanding the arrow next to Search at the boom of
the tree.

The Standard Text editor displays on the right side of the content pane.
4. Enter eld information.

Field Description

*Name
 

Enter the name of the standard text. The item name in the Standard Text tree on the left
side of the content pane is populated or revised as you type.
 

Hotkey
 

Enter the keyboard shortcut leers, numbers, or both in this eld. This lets agents
quickly insert standard text by pressing F8 and the shortcut key when working on an
incident or during a chat session.
 
To locate a keyboard shortcut, hover over a standard text response in the tree.
 

*Type
 

Select at least one of the following check boxes for the standard text type.
 

Rule Text
 

Select this check box to include the standard text as a rule action.
 

Chat Text
 

Select this check box to enable this text to be accessed by agents when engaged in a
chat session.
 
This check box displays only when Oracle RightNow Chat Cloud Service (Chat) is
enabled.
 

Incident Text
 

Select this check box to include this text in the Standard Text list when adding or editing
an incident.
 

Chat URL
 

Select this check box to enable this URL to be accessed by agents when engaged in a
chat session. Agents can push this URL to customers, which opens a browser on their
computer displaying the URL.
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Field Description

This check box displays only when Chat is enabled.
 

*Value
 

Select the appropriate option for adding standard text in plain text or HTML format.
 
If both plain text and HTML versions of a standard text entry are available, the HTML
version displays by default in the Preview section on the Standard Text window.
 

Text
 

Select this option to add the standard text in plain text.
 

HTML
 

Select this option to add standard text in HTML. For information on how HTML elds in
standard text display in responses, see  Answer ID 1434.
 
All standard text images must be referenced by URL.
 

Variables
 

Click this buon to select a variable dened on the Variables editor. See Add or Edit a
Variable.
 

$
 

Click this buon to select from the following system-dened variables. When the
standard text is appended, the variable is replaced with the related data.
 
If you enter a period immediately after the variable, and then an alphabetic character,
 the period becomes part of the variable name.
 

SmartAssistant Solutions
 

Select this option to append the SmartAssistant Solutions variable. $solutions
populates the Value text box.
 

Response Link
 

Select this option to append the Response Link variable. $response_link populates
Value text box.
 

Incidents
 

Select Incidents and then one of the variables on the list. For the list of available
standard content variables, see  Answer ID 6529 . Custom elds and aributes dened in
your system are also on the list.
 
For a description of the standard content variables on the list, refer to the Incidents table
information in the data dictionary ( Conguration > Database > Data Dictionary ).
 

Contacts
 

Select Contacts and then one of the variables on the list. For the list of available
standard content variables, see  Answer ID 6529 . Custom elds and aributes dened in
your system are also on the list.
 
For a description of the standard content variables on the list, refer to the Contacts table
information in the data dictionary ( Conguration > Database > Data Dictionary ).
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Field Description

 

Orgs
 

Select Orgs and then one of the variables on the list. For the list of available standard
content variables, see  Answer ID 6529 . Custom elds and aributes dened in your
system are also on the list.
 
For a description of the standard content variables on the list, refer to the Organizations
table information in the data dictionary ( Conguration > Database > Data Dictionary
).
 

Interface Visibility
 

Select the individual interfaces where you want to display the standard text.
 
All interfaces are selected by default. You can prevent standard text from appearing on
all interfaces by clearing the Select All check box.
 

5. To add folders or organize items and folders in the Standard Text tree, see Add Folders and Folders and Items in
the Tree.

6. Click Save.

CAUTION:  You can delete standard text at any time by selecting the standard text entry in the tree
and clicking Delete on the ribbon. However, when you delete standard text, all instances of the
standard text will also be deleted.

Related Topics
• Insert Standard Text from the Standard Text Window

Add or Edit a Variable  
A variable is a predened shortcut for entering a long string of text when adding an answer, responding to an incident,
engaging in a chat session, or creating standard text. You can add or edit variables from the Variables editor.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Variables.

The Variables tree displays on the left side of the content pane.
3. Choose one of the following options:

◦ To add a variable, click New.

◦ To edit a variable, select the variable in the tree.

Tip:  You can search for variables by expanding the arrow next to Search at the boom of the
tree.

The Variables editor displays on the right side of the content pane.
4. Enter eld information.
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Field Description

*Name
 

Enter the name of the variable. The item name in the Variables tree on the left side of
the content pane is populated or revised as you type.
 
Variable names cannot include spaces. We recommend using an underscore character (_
).
 

Search Indexable
 

Select this check box to index the text for searching on the customer portal.
 

Interfaces
 

Select the interfaces where this variable can be used.
 

Value for Interface
 

Enter the text of the variable. Variables are case sensitive.
 

5. To add folders or organize items and folders in the Variables tree, see Add Folders and Folders and Items in the
Tree.

6. To view answers that are dependent on the variable, click Dependencies.
The Dependencies buon is available only when you edit a variable.

7. To delete a variable, select the variable in the tree and click Delete.
The system performs a dependency check and any answers that contain the variable display on the
Dependency Conict window.

a. To delete all instances of the variable, click Yes. Otherwise, update the applicable answers before deleting
the variable.

8. Click Save.

Related Topics
• Insert a Variable into an Answer

• Add Folders

Service Level Agreements  

Overview of Service Level Agreements  
Service level agreements (SLA) in Oracle RightNow Cloud Service (Service) control the type and amount of support you
oer your customers.

Using response requirements, you can track the eectiveness of your customer service and determine whether sta
members are meeting dened service goals for initial response and incident resolution times.

You can also meter the service and support your customers receive. For example, you can control how many incidents
an organization can submit based on the number of incidents dened in their assigned SLA instance.
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Before you create SLAs, you need to add the holidays your organization observes and dene default response
requirements so you can track sta members’ response and resolution times. Default response requirements are used
for SLAs that do not have custom response and resolution requirements. See Add Custom Response Requirements to an
SLA.

Add or Edit a Holiday  
To ensure your organization meets its service goals, you need to add all holidays observed by your organization.

Holidays work in conjunction with your default response requirements and any custom response requirements dened
in individual SLAs. That is, by adding holidays, you can temporarily suspend response requirements for those days
when sta members are not available to respond to customer inquiries and answer their questions.

For example, if your organization observes Independence Day, add it as a holiday so the defaults you set for response
and resolution times are suspended for that day. Failing to add the holidays your organization observes will present an
inaccurate picture of how sta members are meeting their service goals.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Holidays.

The Holidays tree displays on the content pane.
3. Choose from the following options:

◦ To add a holiday, click New to display the editor.

◦ To edit a holiday, click it in the tree.

4. Enter eld information.

Field Description

*Name Enter the name of the holiday.

*Date Click in this eld and enter the month, day, and year. (The current date appears in this
eld.)
Or
 
Click the calendar to select a dierent day in the month. Use the left and right arrows at
the top of the calendar to change the month, and then click a day.
 

Interface Visibility Select the check box next to each interface for which this holiday applies.
When you have multiple interfaces for dierent countries, you can make a holiday active
in one interface but not in another. For example, since July 4 is a holiday in the United
States but not in Canada, you would select only your U. S. interfaces for this holiday.
However, if your support is handled from the United States, you may want to make the
holiday an option in both Canadian and U.S. interfaces.
 

5. Click Save.

Note:  You must add an entry for all holidays that occur yearly. For example, you must add separate
entries for July 4, 2014, and July 4, 2015.
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Dene Default Response Requirements  
Dene your response requirements. Response requirements are the maximum times allowed for incident response and
resolution during your organization’s operating hours.

For example, you may have a service goal of initially responding to all customer inquiries within one business day (8
work hours) and resolving all incidents within three business days (24 work hours). By dening these default response
requirements, you can measure sta member performance in responding to and solving incidents. You can also use the
response requirements for those SLAs that do not have customized response requirements.

Because Service supports both default and custom response requirements, you have exibility in oering dierent
levels of support to customers. For example, if you want your levels of service to be based on how quickly customers
receive an initial response and their incidents are solved, you can set up custom response requirements for each SLA.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Response Requirements.

The Response Requirements tree displays on the content pane.
3. Click the appropriate interface in the tree to display the editor.
4. Enter eld information for the rst service interval. Press Tab to move between interval elds.

Field Description

Service Intervals Use these elds to select the day and time intervals for the default response
requirements.

New Click this buon to add a new row for the default response requirements.

Delete Click this buon to delete the selected default response requirement.

Day Click this drop-down menu to select a day of the week. Press Tab to move between
elds.

*Start Hour Enter the start hour using a 24-hour clock (for example, if your business day starts at

8:00 A.M., enter 8 in this column).

*Minute Enter the start minute from 0 to 59.

*End Hour Enter the end hour using a 24-hour clock (for example, if your business day ends at 5:00

P.M., enter 17 in this column).

The end hour must be a number greater than the start hour.
 

*Minute Enter the end minute from 0 to 59.

Response Time (Minutes) Enter the maximum number of minutes (between 1 and 99999) that sta members
have to initially respond to a new incident. For example, if you require sta members to

initially respond within 4 hours, enter 240 in this eld.

Resolution Time (Minutes) Enter the number of minutes (between 1 and 99999) that sta members have to solve
incidents assigned to them. For example, if you require that incidents be resolved within

8 hours, enter 480 in this eld.

Holidays Observed Select the holidays that will suspend the response requirements.
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Field Description

Select the Select All check box to select all holidays in the Holidays Observed section.
 

5. Click the Day drop-down menu to select the day for the next service interval and press Tab.

Tip:  You can have the same day of the week listed in two intervals. For example, if your organization
has both day and afternoon shifts, you can add separate intervals for each shift.

6. Click Save.

Related Topics
• Add Custom Response Requirements to an SLA

Resolution Due Calculations  
For SLAs that have response times dened, you can have resolution due dates and times calculated automatically when
an SLA instance is added to an incident.

This saves you from having to perform complex calculations to account for holidays and service hours.

To display resolution due calculations, you must create a custom incident milestones report and add it to a custom
incident workspace. This image shows an incident workspace that has been congured to display resolution due
calculations.

Related Topics
• Create the Incident Milestones Report

• Add the Incident Milestones Report to a Custom Incident Workspace

Create the Incident Milestones Report  
To display resolution due calculations, you must create a custom incident milestones report and then add it to a custom
incident workspace.

1. Create a new report with column denitions.
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Heading Denition

Initial Response Status if(incidents.status_type=2,100,round(((date_di(sysdate(), incidents.rel_due))*-1)/60,0))

Initial Response Due incidents.rel_due

Time Remaining if(incidents.status_type=2,0,round(((date_di(incidents.rel_due, sysdate())))/60,0))

Resolution Due Status round(((date_di(sysdate(), milestone_instances.due_date))*-1)/60,0)

Resolution Due milestone_instances.due_date

Time Remaining if(incidents.status_type=2,0,round(((date_di (milestone_instances.due_date,
sysdate())))/60,0))

2. Use the conditional formaing described in this table for the Initial Response Status and Resolution Due Status
columns.

Condition Display Image Color

Greater than 15
 

Image Only
 

Flag
 

Green
 

Less than or equals 0
 

Image Only
 

Flag
 

Red
 

Less than or equals 15
 

Image Only
 

Flag
 

Yellow
 

3. Use the Minutes (Days, Hours, Minutes) format for both Time Remaining columns.
4. Set the following report options to refresh the data regularly:

◦ Refresh the report when data shown is changed in the editor.

◦ Automatically the refresh report by selecting  Regular interval > Auto-Refresh enabled by default >
Interval 55 Seconds .

5. Clear all of the check boxes in the Customize Record Commands window so that no commands will be
available at runtime.

6. Click Save.

Related Topics
• Overview of Custom Reports

• Add the Incident Milestones Report to a Custom Incident Workspace

Add the Incident Milestones Report to a Custom Incident Workspace  
To display resolution due calculations, you must create a custom incident milestones report and then add it to a custom
incident workspace.

1. Copy the standard incident workspace and name it, for example, Incident Milestones.
2. Open the custom incident workspace.
3. Click the Details tab.
4. Add the custom incident milestones report to the Details tab.
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5. Click Save to save the custom workspace.
6. Edit your sta members’ proles to use the new Incident Milestones workspace.

After an SLA instance is applied to an incident, you can view the resolution due date and time. See Credit an Incident to
an SLA Instance.

Related Topics
• Custom Workspaces

• Add or Edit a Prole

How You Set Up SLAs  
After adding your holidays and dening default response requirements for your sta members, you can congure SLAs
for your application.

Begin by deciding what type of SLAs to oer. For example, you could oer certain customers a premium SLA that
provides them with unlimited support for a period of time, and oer other customers a standard SLA that limits the
number of incidents they can submit during a specied time period. In addition, you can control whether customers
without an SLA can access your support site, or submit incidents through email or the Ask a Question page. You can
also add business rules to automatically assign SLAs to specic customers.

Seing up SLAs consists of the following actions.

• Create the SLAs you want to oer. See Create an SLA.

• Set up business rules to automatically assign SLAs to customers. See How You Issue SLAs Automatically. Also,
review how sta members can manually assign SLAs when working on incidents and editing organizations and
contacts. See How You Issue SLAs Manually.

Create an SLA  
SLAs are designed to allow you exibility in providing support to your customers. When you create an SLA, you can
choose the duration of the SLA and limit the SLA based on the number of incidents that can be submied.

You can also assign custom answer access levels to an SLA so that customers have privileged access to special groups of
answers.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Service Level Agreements.

The Service Level Agreements tree displays on the content pane.
3. Choose from the following options:

◦ To add a service level agreement, click New to display the editor.

◦ To edit a service level agreement, click it in the tree.

4. Enter eld information.

Field Description

*Service Level Name Enter the name of the SLA. When you move to another eld, the Label eld in the
Interface Label section is populated with the name you entered in the Service Level
Name eld.

Active Select this check box to allow instances of the SLA to be applied to contacts or
organizations. When selecting or clearing this check box, the name of the SLA (in the
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Field Description

tree) changes from black to orange and displays in italicized font. After clicking the
Save buon on the ribbon, the name changes from orange to light gray and displays in
normal font.
If this check box is cleared, the SLA is considered inactive and cannot be used with
business rules.
 

Self-Service Select this check box to allow customer access to the Answers page on the customer
portal.
If this check box is cleared, customers will not be able to view answers and may be
directed to a permission denied page.
 

Chat Incidents Enter the maximum number of allowable chat incidents. Enter a zero if no incidents are
allowed or leave the eld blank to allow an unlimited number of incidents.

CSR Incidents Enter the maximum number of allowable incidents that can be created by a sta
member for the contact or organization (for example, when customers contact your
organization by phone). Enter a zero if no incidents are allowed or leave the eld blank
to allow an unlimited number of CSR incidents.

Email Incidents Enter the maximum number of allowable email incidents. Enter a zero if no incidents are
allowed or leave the eld blank to allow an unlimited number of email incidents.
If the SLA_SUBMIT_EMAIL conguration seing is enabled, a valid, active SLA must
exist for contacts and organizations to send emails to Service. If the EU_SLA_VISIBLE
conguration seing is enabled, SLA information will be visible in email responses.
 

Self-Service Incidents Enter the maximum number of allowable incidents created from the Ask a Question
page. Enter a zero if no incidents are allowed or leave the eld blank to allow an
unlimited number of incidents.

Total Incidents Enter the total number of incidents allowed from all incident sources.
The number in the Total Incidents eld must be greater than or equal to the value of

any single incident eld. For example, if the number of chat incidents equals 10, and all

other incidents have a eld value of 5, then the total number of incidents allowed must

be 10 or more. The number in the Total Incidents eld must also be less than or equal to
the sum of the values of all of the single incident elds. For example, if the sum of the
eld values is 50, then Total Incidents cannot be greater than 50.
 

Term (Duration) Enter a number in this eld and select days, weeks, months, or years from the drop-
down menu. Leave the eld blank to indicate there is no time limit on the SLA. If you
specify a number, the start date is the date of issue.

Statistics These elds describe the statistics for an SLA.

Total Issued The number of times this SLA has been issued.

Not Active The number of instances of this SLA in the Not Active state.
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Field Description

Active The number of instances of this SLA in the Active state.

Used Up The number of instances of this SLA in the Used Up state.

Disabled The number of instances of this SLA in the Disabled state.

Access Select the answer access levels assigned to the SLA.
Answer access levels will display only if they have been added to the application.
 

Note:  Knowledge Advanced customers must select all options under Access
in order to congure Web Roles and User Groups within Knowledge Advanced
Agent Desktop.

Interface Label This section contains the names of all available interfaces, the languages they are
implemented in, and the language-specic label of the SLA. Click Edit next to an
interface to change response requirements for the SLA. If you do not change response
requirements, the default response requirements are used.
When using multiple-language interfaces, you must enter the label in the Label eld in
the language of the interface.
 

5. Click Save.

Related Topics
• How You Customize Conguration Seings

• Add or Edit an Answer Access Level

• View Disabled SLA Instances

Add Custom Response Requirements to an SLA  
You can dene custom response requirements for each SLA or use the default response requirements already dened.

1. When adding or editing an SLA, click Edit next to the interface in the Interface Label section.
The Response Requirements window displays.

2. Complete the Service Intervals, Response Time, Resolution Time, and Holidays Observed elds. See Dene
Default Response Requirements.

3. Click Save.

How You Issue SLAs Automatically  
After you create SLAs, they can be automatically issued to organizations and contacts with no organization association
using business rules.

After an SLA has been automatically applied to an organization or contact, a unique SLA instance is associated with the
organization or contact. See Examples of Applying Service Level Agreements (SLAs).

Note:  Contacts associated with an organization cannot be assigned an SLA instance, as the SLA instance is
applied to the organization.
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How You Issue SLAs Manually  
Sta members can manually apply SLAs to organizations and contacts when editing incidents associated with an
organization or contact.

After a sta member has applied an SLA, a unique SLA instance is associated with that organization or contact.

If an organization or contact has more than one active SLA, sta members can select which SLA to apply to an incident.
For example, a contact may have two active SLAs, one that allows unlimited incidents and lasts for thirty days, and
another that allows ten of each type of incident and lasts for one year. If a new incident is applied to the limited incident
SLA, the sta member can re-assign the incident to the unlimited incident SLA to more eciently use the customer’s
entitlements. See SLA Instance Field.

How You Maintain SLAs  
Maintaining your SLAs is an important part of your customer service solution, and Service provides you with tools for
evaluating the performance of your SLAs and how they are meeting your customers’ needs.

You can also edit SLAs as necessary.

• SLA Reporting

• Edit an SLA

• View Disabled SLA Instances

SLA Reporting  
With Analytics, you can track and report on sta members’ performance and service level achievements.

You can see the usage status of SLAs as well as generate specic reports regarding performance and achievement
requirements of each SLA. Analytics can assist you in evaluating and monitoring agent performance, SLA usage and
performance, and customer support levels. SLA analytics are located in Public Reports/Service/SLA Reports.

For statistical information about individual SLAs, see Create an SLA.

Edit an SLA  
Analyzing your SLAs can help you pinpoint the most eective ones and the ones that may need to be changed. You can
edit your SLAs at any time.

After an SLA instance is applied to an organization or contact, it cannot be changed. When you edit an SLA, the changes
will not aect the instances of the SLA that have already been applied to organizations or contacts. Changes will aect
only future instances of the SLA applied to a contact or organization. For your reference, a view-only version of the SLA
instance is archived. See View Disabled SLA Instances.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Service Level Agreements.

The Service Level Agreements tree displays on the content pane.
3. Click the appropriate service level agreement in the tree to display the editor.
4. Edit eld information as necessary. See Create an SLA.
5. Click Save.

The next time you assign this SLA to contacts and organizations, the changes will apply to all instances of the SLA.

View Disabled SLA Instances  
If an SLA is edited after an instance of the SLA has been assigned to contacts or organizations, the assigned instance is
converted to read-only mode to prevent editing.
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The read-only version of the SLA instance is archived, leing you view the seings for the previous, or “disabled,”
instance of the SLA.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Service Level Agreements.

The Service Level Agreements tree displays on the content pane. If a disabled SLA exists, an arrow displays next
to the active SLA it is associated with.

3. Click the arrow to view the disabled SLA. Disabled SLAs display in a light gray font.
4. Click the disabled SLA you want to view.

The Service Level Agreement editor displays on the content pane and the disabled SLA opens in read-only
mode.

Examples of SLAs  
These SLA examples show you how to meter service and oer dierent levels of support to your customers. SLA
examples are provided for a 30-day SLA, a grace period SLA, and a premium SLA.

• Add a 30-Day SLA

• Add a Grace Period SLA

• Add a Premium SLA

Add a 30-Day SLA  
This example shows you how to add a 30-day SLA that restricts support to 30 days, but lets contacts and organizations
submit an unlimited number of incidents during that time period.

Support begins when the SLA is assigned and automatically ends after 30 days. In this example, the default response
requirements are used.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Service Level Agreements.

The Service Level Agreements tree displays on the content pane.
3. Click New.
4. Enter 30 Days in the Service Level Name eld.
5. Select the Active check box.
6. Select the Self-Service check box to allow access to the customer portal.
7. Enter 30 in the Term (Duration) eld and select Days from the drop-down menu.

Note:  Do not enter any number in the Chat Incidents, CSR Incidents, Email Incidents, Self-Service
Incidents, and Total Incidents elds. Leaving these elds blank, or null, will let contacts and
organizations assigned this SLA submit an unlimited number of each type of incident until the 30-day
term has expired.

8. Click Save.

Add a Grace Period SLA  
This example shows you how to add a two-incident SLA that could be assigned to contacts or organizations whose SLAs
have recently expired.

The duration is dened using the Total Incidents eld. The Term (Duration) eld is left blank because the dening
measure is the number of incidents, not the length of time. In this SLA, the default response requirements are also used.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Service Level Agreements.

The Service Level Agreements tree displays on the content pane.
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3. Click New.
4. Enter Grace Period in the Name eld.
5. Select the Active check box.
6. Select the Self-Service check box to allow access to the customer portal.
7. Enter 2 in the Total Incidents eld.

Leaving the Chat Incidents, CSR Incidents, Email Incidents, and Self-Service Incidents elds blank, or null, will
let contacts and organizations assigned this SLA submit an unlimited number of incidents. By entering the
number 2 in the Total Incidents eld, you are leing customers submit 2 of any incident type, but limit the total
number of incidents the contact or organization can submit to 2.
The Term (Duration) eld is blank because there is no time limit on the SLA. Contacts and organizations may
submit the incidents at any time, until they have submied two incidents, at which time the SLA will expire.

8. Click Save.

Add a Premium SLA  
This example shows you how to add a type of SLA that could be oered to organizations or contacts who request
premium service. It is set up to provide faster incident response and resolution times than standard SLA entitlements.

For example, sta members must initially respond within four hours and resolve incidents within two working days
(sixteen hours).

The SLA has a duration of one year and will allow forty total incidents comprised of ten chat incidents and thirty CSR
incidents. In this SLA, custom response requirements are used. See Add Custom Response Requirements to an SLA.

1. Click Conguration on the navigation pane.
2. Expand  Service > Service Level Agreements , and then double-click Service Level Agreements.

The Service Level Agreements tree displays on the content pane.
3. Click New.
4. Enter Premium in the Name eld.
5. Select the Active check box.
6. Select the Self-Service check box to allow access to the customer portal.
7. Enter 10 in the Chat Incidents eld.
8. Enter 30 in the CSR Incidents elds.
9. Enter 40 in the Total Incidents eld.

Note:  The number in the Total Incidents eld must be greater than or equal to the value of any single
incident eld. For example, if the number of chat incidents equals 10, and all other incidents have a
eld value of 5, then the total number of incidents permied must be 10 or more. The number in the
Total Incidents eld must also be less than or equal to the sum of the values of all of the single incident
elds. For example, if the sum of the eld values is 50, then Total Incidents cannot be greater than 50.

10. Enter 1 in the Term (Duration) eld and select Years from the drop-down menu.
11. Click Save.
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Oer Advisor Administration  

Overview of Oer Advisor Administration  
With Oer Advisor, you can create promotions and dene which groups of customers are eligible for each promotion. It
provides agents with solid information to successfully present oers to customers and contribute to increased revenue
for your organization.

When agents work with your customers, they are in a perfect position to provide information about new and upgraded
products and services with Oer Advisor. Product promotions are a natural use of Oer Advisor. But you can also use
the feature to provide personalized service notices that enhance your levels of customer support. For example, Oer
Advisor can help agents remind customers about soon-to-expire warranties or notify them about product recalls.
Besides the promotions that you create, Oer Advisor also automatically generates product suggestions based on a
customer’s purchase history.

Oer Advisor provides oers—that is, promotional information and product suggestions—your agents can present to
customers who contact your customer support group. With Oer Advisor’s specically targeted oers, an agent has
the ability to cross-sell (by oering products compatible with those the customer has already purchased) or up-sell (by
oering a premium version of a product the customer currently owns). You can also use Oer Advisor to oer SLAs and
renewals, remind customers about warranties, add customers to a newsleer mailing list, provide information about
product recalls, or deliver other messages to your customers. Oer Advisor includes seings that automatically create
sales opportunities when a customer expresses interest in a promotion or suggestion.

To learn how agents use Oer Advisor when they work with customers, see How Oer Advisor Works.

Oer Advisor Conguration  
After enabling and conguring Oer Advisor, sta members can use it while assisting customers.

For instructions on how to enable and congure Oer Advisor, see Answer ID 2729. Conguration options will not be
visible until Oer Advisor is enabled. Contact your Oracle account manager.

Note:  Even with Oer Advisor enabled, you must be sure that the Oer Advisor buon appears on the ribbon
of the workspace that agents use when they work with incidents. By default, it appears on the standard
incident workspace. If agents use a custom incident workspace and the Oer Advisor buon is not available on
the ribbon, they will not be able to tell if a customer is eligible for oers. See Ribbon and Quick Access Toolbar
Buons.

After Oer Advisor is enabled, perform these tasks to congure it.

• Integrate purchase history data—Oer Advisor must have a customer’s purchase history before it can generate
product suggestions and apply target rules that have conditions based on purchase history. When sales
information resides in an external application, you can integrate sales transaction information into your
database, including customer information, purchased products, price, and purchase dates. For information
about integrating purchase history data, contact your Oracle account manager.

• Create targets—Every promotion needs an intended audience, which is its target. You can create unique targets
for specic promotions as well as general targets you can use for multiple promotions. See Targets and Target
Rules.
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• Add promotions—After you have enabled Oer Advisor, integrated purchase history day, and created targets,
you can create promotions that include dates, products, information for the agent, and targets. See How You
Use Customer Promotions.

Customer Promotions  
A promotion is a program dened by a sta member, usually from the marketing department, that species the
eective dates, the product (if applicable to the promotion), the promotion’s priority, and the target eligible for the
promotion.

The promotion description contains information for the agent, such as a text guide to help the agent present the
promotion to the customer. The promotion also denes which targets are eligible for the oer. Targets are created using
Oer Advisor target rules, a unique type of business rule. Customers who meet the conditions specied in a target rule
are automatically added to the dened target.

When an agent responds to a customer’s question, Oer Advisor retrieves information about the customer and
the incident. Oer Advisor then applies the target rules and evaluates the customer information to determine if the
customer belongs to a target. If the customer belongs to one or more targets, Oer Advisor searches for promotions the
target is eligible for and displays them to the agent.

The displayed list of available promotions includes the assigned priority ranking and acceptance rate for each
promotion. Also shown is the date of the most recent positive response, if any. (Previously refused oers are not
displayed to avoid repeating an oer in which the customer has already expressed no interest.)

How to Use Suggestions to Recommend Products  
A suggestion is an automated product recommendation that predicts customer interest based on purchase history (if
data is integrated into the Oracle Service Cloud application).

Unlike promotions, which are created by marketing personnel, suggestions for recommended products are
automatically generated. Oer Advisor uses a predictive model to develop product suggestions based on the customer’s
purchase history.

Oer Advisor rst identies groups of customers who have similar purchasing behavior. When a customer submits an
incident, Oer Advisor assigns the customer to the best matching group. Then Oer Advisor compares products the
customer has already purchased to products purchased by other members of the group. For example, the customer
may belong to the group of customers who have purchased cruise vacations. If many members of that group have taken
Alaskan cruises, but the customer has not, Oer Advisor may recommend an Alaskan cruise as the customer’s next
purchase.

Oer Advisor ranks a product suggestion based on the strength of the recommendation (that is, the probability that
the customer is interested in the oer). Oer Advisor does not generate suggestions when it does not have enough
information for the customer or when it predicts a low likelihood of the customer accepting the oer.

Text Matching  
When the Oer Advisor window displays promotions and suggestions, an agent can search for specic terms that best
express the customer’s interests.

The search reorders the oers, ranking each according to its match weight.

Match weight depends on where the search term is found in an oer. For example, if the agent-entered search term
matches a keyword for the promotion, the oer has a higher match weight than it would if the search term were found
in the product description. Match weights are high (best match), medium, or low. The highest weight occurs when the
agent-entered search terms match promotion keywords. Medium weights are assigned when the search term matches
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the promotion or product name or the text in the promotion’s summary eld. Low weights result when terms match the
promotion guide or product description.

Targets and Target Rules  
Every promotion is associated with at least one target, which is the group of customers to whom you want to present
your promotion. You can create a target to use for a single promotion, or you can create general targets to be used with
multiple promotions.

Targets are created with target rules, which are one type of business rule. Business rules automate your workow by
establishing a set of conditions and a resulting action. If the conditions are met, the action is taken.

Target rules single purpose is to dene targets—groups of customers—that meet the conditions you specify. You add
a rule to specify the conditions you want a customer to meet and if the conditions are met, the customer automatically
becomes part of the target.

For example, you might want to promote SLAs. Using target rules, you can use product purchase dates to identify
customers with expiring warranties who constitute your target. In another example, you might want to promote a
premium calling plan for cellular phone customers in a specic region. You can use target rules to specify geographical
limits and identify those customers who currently have basic calling plans. In another situation, you might create a
target consisting of all your customers. In that case, you simply name the target and save the rule without seing any
conditions.

For information about how agents interact with Oer Advisor, see How Oer Advisor Works.

Related Topics
• Overview of Business Rules

Create a Target Rule  
When you dene the conditions of a target rule, you can dene targets in terms of a large number of aributes,
including demographic information you can gather using custom elds.

Because only one state is permied for target rules, this state—called Targets—is automatically added when you open
target rules. You cannot add states or functions in target rules. Regardless of the conditions you select, the default
action is always “Contact will match this target.” You cannot add an action for the Else clause of a target rule.

When you dene the conditions of a target rule, you can use elds from the incident, contact, and organization tables in
the database. This lets you dene targets in terms of a large number of aributes, including demographic information
you can gather using custom elds. You can also create a target that includes all of your customers by creating a rule
that has no conditions. For lists of the elds allowed for incident, contact, and organization objects, see Business Rule
Conditions.

You can also select a unique Purchased Products condition for target rules. The Purchased Products condition is
actually a combination of three conditions, all of which must be met in order for the Purchased Products condition to
be met. These criteria are product, price, and date purchased. In the Purchased Products condition, you can include or
restrict products, dene the price range, and specify the time frame of purchases.

This procedure creates a target rule with a Purchased Products condition.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Rules.

The Rules tree and editor display on the content pane.
3. Click Oer Advisor.

The Browse Targets editor opens.
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4. Click Edit.
The Target editor opens.

5. Right-click Targets in the tree and select New Rule.
The Targets editor is activated.

6. Enter the name of the target rule in the Rule Name eld.
7. To add notes to the rule, enter them in the Notes eld.
8. Click Add IF Condition Based On and select Purchased Products.

9. Enter eld information.

Field Description

Product Select a product from the menu. To select multiple products, press Ctrl while selecting
each product. For information about adding sales products, see Add or Edit a Sales
Product.

Price Click this drop-down menu and enter a value in the Amount eld. Click the Currency
drop-down menu and select the currency.

Date Purchased Click the drop-down menu to open the current month’s calendar and select a purchase
date. Use the arrows at the top to change the month if necessary. Or select the Relative
check box to select a relative time condition. See Select the Relative Time Condition for
Date Purchased.

10. Select the operator for the Product, Price, and Date Purchased conditions from the Select Operator drop-down
menu. The available operators are described in the table.

Field Description

Equals Select this operator if you want the product, price, or purchase date to exactly match the
selection.

Not equals Select this operator if you do not want the product, price, or purchase date to exactly
match the selection.

Less than Select this operator if you want the price to be lower than the entered price or the date
to occur before the selected date.

1079



Oracle Service Cloud
Using Service Cloud

Chapter 5
Service

Field Description

Greater than Select this operator if you want the price to be higher than the entered price or the date
to occur after the selected date.

Less than or equal to Select this operator if you want the price to be lower than or equal to the entered price
or the date to occur before or on the same date as the selected date.

Greater than or equal to Select this operator if you want the price to be higher than or equal to the entered price
or the date to occur after or on the same date as the selected date.

In range Select this operator if you want the price or purchase date to fall within the range you
specify.

Not in range Select this operator if you want the price or purchase date to fall outside the range you
specify.

Is null Select this operator if you want the price or purchase date to contain no value.

Is not null Select this operator if you want the price or purchase date to contain a value.

11. Click Save to save the target rule.
12. Click Activate to compile and activate the target rule base. See Compilation and Activation of Rule Bases if you

need help with this step.

Note:  If you click Compile instead of Activate, the rule is checked for errors, but not activated. Oer
Advisor does not apply this target rule to customer information until it has been activated.

Select the Relative Time Condition for Date Purchased  
The Purchased Products condition lets you select a value for the Date Purchased part of the condition. There may be
times when you want to set a specic date and time, which you can do by opening the calendar and selecting them. At
other times, however, you might want that value to be relative.

If you want a condition “If the purchase date is less than 24 hours from the time the contact was acquired”, for example,
you can select a relative time for the rule condition. Relative time calculates the number of minutes or hours from the
current time or from a specic event, such as the time the contact or incident was created.

This procedure shows you how to set a relative time condition using the time a contact was acquired, but the procedure
is the same for seing other relative time conditions.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Rules.

The Rules tree and editor display on the content pane.
3. Click Oer Advisor.

The Browse Targets editor opens on the content pane.
4. Click Edit.
5. Right-click the rule you want to add the relative time condition to and select Edit.

The Target editor is activated.
6. Click Add IF Condition Based On and select Purchased Products. In this example, assume you want the target

group to include those contacts who purchased a product within twenty-four hours of being acquired as a
contact.

7. Select the Relative check box for Date Purchased.
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The calendar drop-down menu is removed and the Relative time eld displays.
8. Click the Relative Time drop-down menu above the Relative check box.

The Relative Time window opens.
9. Complete the elds in the Relative Time window.

10. Click the Directions drop-down menu and select + (Future).
11. Enter 24 in the Oset eld.
12. Click the Unit drop-down menu and select Hours.
13. Click Save to save your seings and close the Relative Time window.
14. Click the Event drop-down menu to the right of the Relative check box and select Contact.Acquired.
15. Click the Select Operator drop-down menu and select Less Than.
16. Click Save to save the new relative time condition for the rule.

How You Work with Promotions  
Promotions include the product or message you want agents to present to customers who belong to a specic target
group. Promotions also dene the active dates, the promotion’s priority, URLs to open when customers express interest
in or accept a promotion, and scripts and tips for agents.

You may nd it helpful to use existing promotions as the basis for new promotions. In those cases, you can save the
promotion with a new name and then make any changes. Even if you do not intend to make any changes, you should
rename the promotion so it is possible to distinguish between them in reports.

Because every promotion requires at least one target, you must dene the promotion’s target before you can complete
the promotion. When you add a promotion, you may already have a target you want to present the promotion to, or you
may decide to create a target specically for this promotion. If you begin creating a promotion before dening a target,
you can save the promotion and return later to assign a target.

If your promotion applies to a sales product, you must also be sure the product is in the product catalog. For example,
you might create promotions that oer a discount on a new model of cell phone or a free warranty with a purchase. In
these examples, the sales products are the cell phone and warranty. In another example, you might want to oer free
shipping on all purchases or create a promotion that simply makes an announcement to your customers. In those cases,
do not specify a sales product when you create the promotion. See Add or Edit a Sales Product.

After you know what product and targets are included in your promotion, you can add the remaining details. These
include start and end dates, priority, URLs for taking the next action, and information to guide the agent in presenting
the promotion to customers.

Note:  Even though the Promotions editor lets you create a promotion, it does not make other changes that
may be necessary to enact the promotion. For example, if you create a promotion that oers an extended
service agreement, you must also change the customer’s SLA to reect acceptance of the promotion.

Related Topics
• Targets and Target Rules

Add or Edit a Promotion  
Follow this procedure to add or edit a promotion.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Promotions.

The Promotions tree displays on the content pane.
3. Do one of the following:

◦ To add a promotion, click New to display the editor.
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◦ To edit a promotion, click it in the tree.

4. Enter the name of the promotion in the Name eld.
5. To dene properties, see Select Details for a Promotion.
6. To enter a summary, guide, and keywords, see Provide Promotion Information to Agents.
7. To specify targets, see Select Targets for a Promotion.
8. Click Save.

Select Details for a Promotion  
You can dene the start and end dates, the product associated with a promotion, its priority, and the URLs that agents
are directed to based on customer response.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Promotions.

The Promotions tree displays on the content pane.
3. Click the promotion in the tree to display the editor.
4. Enter eld information.

Field Description

Activated Select this check box to activate the promotion. To discontinue a promotion during its
active period (between the start and end dates), clear the check box.
 

Start Date Click this drop-down menu to open the current month’s calendar and select a start date
for the promotion. Use the arrows at the top to change the month, if necessary, and
then select the date.
 

End Date Click this drop-down menu to open the current month’s calendar and select an end date
for the promotion.
 

*Priority Click this drop-down menu to select a priority for this promotion. 1 is the highest priority
and 10 is the lowest. Priority determines the promotion’s order in the list seen by agents.
 
If two or more promotions with the same priority are oered to the customer, their
positions in the promotions list are random.
 

Sales Product Click this drop-down menu and select the sales product (if you want the promotion to
have a sales product).
 
Promotions do not require a sales product. For example, you might want to oer free
shipping on all orders, so you would not make a sales product selection.
 

Yes URL Enter the URL the agent is directed to if the customer accepts the promotion. For
example, you might direct the agent to an order form with a discounted price.
 
You can pass variables through this URL to populate the page with contact information
or other elds you select.
 

1082



Oracle Service Cloud
Using Service Cloud

Chapter 5
Service

Field Description

Interest URL Enter the URL the agent is directed to if the customer expresses interest in the
promotion. For example, you might direct the agent to a form for entering leads.
 
You can pass variables through this URL to populate the page with contact information
or other elds you select.
 

Create Opportunity on Yes Select this check box to add an opportunity when the customer accepts the promotion.
The opportunity is added automatically with no input required from the agent
presenting the oer.
 

Create Opportunity on Interest Select this check box to add an opportunity when the customer expresses interest in
the promotion. The opportunity is added automatically with no input required from the
agent presenting the oer.
 

Notes Enter comments, reminders, and other information about the promotion.
 

Provide Promotion Information to Agents  
You can provide information to help agents present promotions to customers. In addition, you can add a summary of
the promotion and keywords associated with the promotion.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Promotions.

The Promotions tree displays on the content pane.
3. Click the promotion in the tree to display the editor.
4. Click Description to open the Description page.
5. Enter eld information.

Field Description

Summary Enter the text the agent will see in the list of promotions displayed on the Oer Advisor
window.
 

Guide Enter a script, sales tips, or other guidelines to help the agent present the promotion to
the customer.
 

Keywords Enter keywords in this eld. Oer Advisor compares these keywords, along with other
words associated with the promotion, to the search terms the agent enters to nd oers
matching the customer’s interests.
 

6. Click Save.
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Select Targets for a Promotion  
You can assign one or more of the available targets to the promotion you are adding.

If you want to dene a new target for this promotion, see Targets and Target Rules. If you dene a new target before you
nish creating the promotion, you must activate the target rule and reopen the Promotions editor. The new target then
appears in the Available Targets list so you can assign it to the promotion.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Promotions.

The Promotions tree displays on the content pane.
3. Click the promotion in the tree to display the editor.
4. Click Targets to open the Targets page.
5. Select a target for this promotion in the Available Targets list and click the right arrow.

The target displays in the Assigned Targets list.
6. To assign additional targets, repeat the previous step.
7. To remove a target, select it in the Assigned Targets list and click the left arrow.

The target now displays in the Available Targets list.
8. Click Save.

How You Modify Promotions  
You can edit and delete promotions as necessary.

To edit a promotion, click it in the tree. Make your changes and save the promotion. You can also copy a promotion,
modify it, and save it with a new name. The default name is Copy of [Promotion Name].

If you want to modify an existing promotion to use as a new promotion, it is good practice to open the promotion and
save it with a new name. If you merely edit the properties of a promotion and do not change the name, your historical
data regarding the eectiveness of that promotion may become skewed, preventing accurate reporting.

For example, if you create a Holidays 2018 promotion by renaming the Holidays 2018 promotion, you can distinguish
statistics from each promotion, even if everything else in the two promotions is identical. If, however, you do not change
the name, two years worth of data are combined in one report, making it impossible to distinguish between them.

This practice also allows agents to present the Holidays 2019 promotion to customers who were not interested in the
2018 promotion. If the name does not change, the promotion is not available to customers who said no to the previous
year’s promotion.

To delete a promotion, click Delete. A message asks you to conrm the deletion.

Note:  Deleting a promotion may prevent accurate reporting by causing some reports to be incomplete. It is
good practice to delete only old promotions that are no longer required for historical purposes. You can also
add a folder for archiving purposes.
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Oer Advisor  

Overview of Oer Advisor  
When working with customers, you are in a unique position to anticipate their needs and provide them with specically
targeted information. Oer Advisor identies current promotions for which customers are eligible, and generates
product suggestions based on their purchase histories.

Oer Advisor does more than simply provide you with a list of oers. It also displays guides to help you present the oer
or information to the customer. It may contain product information and direct you to URLs to enter information about
orders or leads. Oer Advisor can help you deliver high levels of personalized customer service by providing customers
with reminders and service opportunities.

Promotions are special oers made to specic groups of customers. Examples of promotions include free shipping for
customers who buy certain products, extended warranties for customers whose basic warranty is about to expire, and
discounted prices on accessories for products customers have already purchased. A sta member in your organization,
usually from the marketing department, denes a promotion.

Suggestions, on the other hand, are generated automatically. These are product recommendations based on customer
characteristics and purchase history. Just as SmartAssistant searches the knowledge base and suggests possible
answers to a customer’s questions, Oer Advisor searches for customer characteristics and past purchases to suggest
possible products they may be interested in. For example, Oer Advisor may suggest a Caribbean cruise to a customer
who has previously purchased a Mexican cruise vacation.

How Oer Advisor Works  
Oer Advisor evaluates customer information when you open an incident, and searches for promotions the customer is
eligible for and product suggestions that the customer might be interested in.

If it nds promotions, product suggestions, or both, the Oer Advisor buon is enabled on the ribbon.

After you solve the incident, click Oer Advisor. The Oer Advisor window displays and contains the promotions and
suggestions found during the search.

Promotions Found Section  
The Promotions Found section of the Oer Advisor window displays promotions for which the customer is eligible.

The maximum number of displayed promotions has been set by your administrator, so it is possible that the customer is
eligible for other lower-ranking promotions that do not appear unless you scroll down.

Note:  If the customer previously expressed no interest in a promotion, the promotion does not appear on the
Oer Advisor window, and you will not be put in the position of presenting a promotion the customer has
already rejected. Nor will the product associated with the rejected promotion appear in the Suggestions Found
list.
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When working with promotions, keep the following points in mind.

• You can revise the order of the promotions using any of the column headings in the Promotions Found section,
although the Rank, % Yes, and Match columns are the most useful. The Name column is simply the name
assigned to the promotion by the marketing sta member who developed it. The Summary column provides a
brief overview of the promotion.

• Promotions are initially ranked by priority, which is the relative importance assigned to it by the sta member
who created it. These values appear in the Rank column. Although a rank of 1 indicates the highest priority,
multiple promotions that have the same priority are not dierentiated by rank in this list, so lower promotions
may have the same priority as the rst promotion.

• The % Yes column lists the historical response rate, which is the percentage of times customers have accepted
this promotion. To rearrange the promotions in order of acceptance, click the column heading.

• You can enter search terms that indicate the customer’s interest. The Match column prioritizes promotions
based on how well your search terms match keywords and other text of the promotion or product. To list the
promotions in order of match, where a high value indicates a strong match, click the Match column heading.
Lower-ranking promotions that did not appear when the list was prioritized by rank may now be displayed
based on their match with the search terms you entered. To learn how to search for matches, see Enter Search
Terms.

• The column titled Dup? is used to indicate whether the product in the promotion is duplicated in a suggestion.
If the same product appears in Promotions Found and Suggestions Found, the Dup? value in the row is Yes and
is highlighted.

Suggestions Found Section  
The Suggestions Found section of the Oer Advisor window displays recommendations for products that Oer Advisor
has determined are a good t for the customer.

The maximum number of displayed suggestions has been set by your administrator, so it is possible that other
lower-ranking suggestions are available even though they may not appear until you scroll down. Just as you can with
promotions, you can revise the order of suggestions using the Rank, % Yes, and Match columns.

Guide Section  
The Guide section of the Oer Advisor window contains information about a selected promotion. This information was
entered for your use by the marketing sta member who created the promotion.

Depending on your organization’s practices, the information may be a script for a phone conversation, text you can
enter into an email response, or simply talking points for the promotion. For example, if most of your customer support
requests come through phone calls, the marketing sta member may write a general script for you to use when talking
with a customer. If your main channel of communication with customers is through email, the guide may contain text
you can copy or append to the response.

The Guide section displays “Oer Guide is unavailable” if you have selected a suggestion instead of a promotion or if
marketing personnel did not enter information when creating the promotion.

To copy information in the Guide section that you want to paste into the response, right-click in the Guide section and
select Copy. To append the information to the response, right-click and select Append To Thread.

Product Details Section  
The Product Details section contains information from the Sales Product Catalog about the selected product suggestion
or the product for the selected promotion.
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Promotions do not require an associated product. If the selected promotion does not involve a product, this section
displays “Product Details are unavailable.”

To copy information in the Product Details section that you want to paste into the response, right-click in the Product
Details section and select Copy. To append the information to the response, right-click and select Append To Thread.

How You Present Oers  
After you have opened the Oer Advisor window, you can review the promotions and suggestions to determine which
one to select to present to the customer.

You can revise the order of the lists of promotions and suggestions to help you decide which oer has the highest
potential of success. You can select the oer’s rank or its acceptance rate, or you can enter search terms to determine
how well the oer matches the customer’s interests and use the match value as your selection criterion.

Tip:  You should strongly consider any oer with Yes displayed on a green background in the Dup? column.
This indicates a product that appears in both promotions and suggestions.

• How You Select a Promotion or Suggestion

• Enter Search Terms

• Present an Oer

How You Select a Promotion or Suggestion  
After you have opened the Oer Advisor window and reviewed the promotions and suggestions, you can select one to
present to the customer.

To use rank as the selection criterion, select the promotion or suggestion ranked 1.

To use acceptance rate, click the% Yes column heading to list the promotions in order of acceptance rate.

Enter Search Terms  
You can enter search terms to determine how well an oer matches the customer’s interests and use the match value as
your selection criterion.

1. Click Search on the boom of the Oer Advisor window.
The Oer Advisor Search window opens.

2. Enter the search terms, separated by a space or comma, and click OK.

Note:  The search terms you enter are applied only to the promotions and suggestions available to this
customer, not to all promotions and suggestions.

The list of oers is automatically ranked according to match value.

Present an Oer  
Present an oer you have selected for the customer.

1. Do one of the following:

◦ If you are on a phone call with the customer, read or paraphrase the guide and product information to the
customer.
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◦ If you are responding to an incident, right-click in the guide or product information section to copy the
text or append it to the response. Modify as necessary before sending the response.

2. Click Set Response in the Action column for the oer you want to present.
The associated drop-down menu in the Response column is activated.

3. Click the drop-down menu and select an option.

Option Description

Yes Select this option if the customer accepts the oer. Depending on how the promotion is
dened or how Oer Advisor is congured, this buon may take you to a URL for follow-
up action (for example, an order form).

Interest Select this option if the customer expresses interest in the oer but is not ready
to accept it. Depending on how the promotion is dened or how Oer Advisor is
congured, this buon may take you to a URL for follow-up action.

No Select this option to indicate the customer’s lack of interest in the oer. The promotion
or suggestion is disabled in the Oer Advisor window, and the response is recorded to
prevent the oer from being made to this customer in the future.

Defer Select this option when you are sending the oer by email and do not yet know the
customer’s response.

4. Click OK to return to the incident.
5. Click Save to save the incident and record the customer’s responses to the oers. If you do not save the

responses, the reports generated by managers and marketing sta will not account for these responses, and
the historical information with this customer will not be accurate for future interactions.

Note:  If you send an email to a customer who replies with an indication of interest, you can reopen
the incident, open the Oer Advisor window, select the promotion or suggestion, and select Yes,
Interest, or No to document the response appropriately.
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6  Customer Portal

Conguring Oracle Service Cloud for the Customer Portal
 

Overview of Customer Portal  
The Oracle RightNow Customer Portal Cloud Service (Customer Portal) is the interface your customers use to interact
with your customer support.

Your customers can use your customer portal to access a variety of self-help tools, including:

• searching for product and support information

• reviewing the contents of your knowledge base

• asking questions of your support sta and your user community

• chaing with sta

• managing their account information

Because the Customer Portal is integrated with your Oracle Service Cloud application, any information customers enter
by submiing an incident, updating account information, or providing feedback on an answer is immediately available
to your support sta on the Oracle Service Cloud administration interface.

To meet your business needs, you congure your customer portal. Some conguration occurs in the Oracle Service
Cloud administration interface, while editing the templates, pages, widgets, and inlays is completed using third-party
tools and software.

Here are a few basic points to keep in mind as you begin working with your customer portal.

• The reference implementation is the set of default pages and les that make up the Customer Portal as it exists
before you make modication for your specic needs. Edit the default les so they meet your organization’s
support goals. You can match the appearance of the rest of your organization’s website. After working with the
default pages, you should understand the concepts well enough to create any custom pages you may need.

• You’ll use a text editor such as TextPad, NotePad, Notepad ++, WordPad, or Adobe Dreamweaver to build and
modify your customer portal pages. You’ll also need a WebDAV client for downloading and uploading les.

Note:  We recommend using Cyberduck version 4.4. Other versions of Cyberduck may not work as
expected, or with mixed results.

• You use conguration seings on the Oracle Service Cloud administration interface to set up certain
functionality for your customer portal, such as SmartAssistant and search options. But you’ll use the Customer
Portal Administration site, your text editor, WebDAV, widgets, and inlays to congure the customer portal
pages.
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Oracle Service Cloud Elements Used in Customer Portal  
Your Customer Portal relies on Oracle Service Cloud elements to function.

The knowledge base is the term we use to describe how information in the database is presented. This is information
sta members see on the agent desktop and customers see on your customer portal. This is some of the information in
the knowledge base.

• Contacts—Each of your customers has a contact record in the knowledge base that includes basic information,
such as name, email address, and phone number. Contact records also include information about any support
issues or questions the customer has submied as well as any other information your organization asks
customers to provide.

• Answers—Answers are the heart of your knowledge base. Whether your organization calls them FAQs, help
topics, or something else, an answer is the information in the knowledge base that provides a solution to a
common customer support question. Your customers can search for answers to their questions, and you can
create new answers from questions your customers commonly submit.

• Incidents—Incidents are created automatically when your customers submit a request for help through the Ask
a Question page of your customer portal or when they provide feedback on your site or a specic answer.

• Reports—A report is simply a list of records. The application oers a full range of standard reports, and you can
also create custom reports. The list of answers that is returned when a customer conducts a search is simply
a report that has been ltered on the search terms. Customer Portal reports are listed on the administration
interface and can be accessed by clicking the Analytics buon and then opening the Reports explorer to nd
Public Reports/Service/Views–Service/Customer Portal.

• Conguration seings—You can accomplish most of the conguration of your customer portal by editing code
for the templates, pages, and widgets that make up your site. There are, however, certain properties that are
congured through the administration interface using conguration seings that dene behavior on your
customer portal.

• Message bases—A message base is an editable text string that lets you customize headings, labels, buons,
and other text on your customer portal. When you reference a message base by its standard name in a line of
code, the page automatically displays the text of the message base.

• Data dictionary—The data dictionary lists the available database tables and elds that can be used for many
input and output widgets. You can also use the Business Objects link on the Customer Portal Administration
site (Framework > Business Objects) to look up eld and table names for contacts, answers, and incidents.

View Your Customer Portal  
As you’re working on changes to your customer portal pages, you can use the server’s development area to view them.
You can set your site to open the pages that your customers see on your production site or your development pages.

When you open your customer portal, the set of pages that opens depends on which area you’ve selected to view on
the Customer Portal Administration site: production, staging, development, or the reference implementation. You might
be looking at the development pages you’re working on but haven’t yet staged and promoted. Or you may be viewing
the same production pages your customers see.

1. Open your customer portal by doing one of these:

◦ Launch a web browser and enter the URL for your site: hps://<your_site>/app.
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◦ From the le menu on the Service Console of your Oracle Service Cloud application, select  Link >
<your_site> > End-user .

2. To view development pages:
a. Go to hps://<your_site>/ci/admin.
b. Select View Development Area on the dashboard.

Overview of WebDAV  
The customer portal uses WebDAV to help you manage your website les.

WebDAV oers a familiar le structure, easy uploading and downloading of multiple les, and le security through login
access. After you set up a WebDAV connection to upload and download les, you can use any text editor you want to
create and edit les for your customer portal, or you can use Adobe Dreamweaver, which uses its own WebDAV protocol
for site management and conguration.

Note:  If you use special characters in any PHP le, you must use a text editor that lets you save the le with
UTF-8 encoding without the leading Byte Order Mark (BOM) character.

Related Topics
• Enable MOD_CP_DEVELOPMENT_ENABLED

• Access les with WebDAV (video)

View Customer Portal Files  
Administrators can view les stored on the customer portal server from the Customer Portal Administration site or from
their local workstation.

1. To view les on your local workstation:
a. Browse to the local location you specied in your WebDAV setup.

Note:  We recommend editing downloaded les and then uploading them back to the server.

b. Click folders to navigate through the site les.
c. Double-click the lename to open the le for editing.

2. To view les on the customer portal server:
a. In a web browser, enter hps://<your_site>/dav.
b. Click the cp link to display the folders.
c. Click folders to navigate through the site les.
d. Double-click the lename to open the le for editing.

Oracle Service Cloud and Your Customer Portal  
Administrators should do some basic conguration before working with pages, widgets, and inlays.
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Before you get started working with pages, widgets, and inlays, you’ll want to do some basic conguration for the Oracle
RightNow Customer Portal Cloud Service (Customer Portal) on the administration interface.

• Assign appropriate permissions to sta members who will be working with your customer portal.

• Review the conguration seings to be sure you don’t need to change any of the defaults.

• Set up additional conguration options for features that are accessed through your customer portal, such as
search options, SmartAssistant, related answers and web indexing.

Assign Permissions for Customer Portal  
Access to edit and modify your customer portal is given through Oracle Service Cloud prole seings.

1. Log in to Oracle Service Cloud.
2. Double-click Proles in  Conguration > Sta Management .
3. Double-click the prole you want to assign permissions to.
4. Click Permissions.
5. Select the appropriate permission:

◦ CP Edit—permission to edit customer portal pages using WebDAV, but not to stage or promote them.
Sta members with this permission can also access the Customer Portal Administration site.

◦ CP Stage—allows prole members to copy the development les to the staging area.

◦ CP Promote—allows prole members to promote customer portal pages from the staging area to the
production area.

6. Click Save.

Enable MOD_CP_DEVELOPMENT_ENABLED  
Before you can make changes to your customer portal development site, you must enable the
MOD_CP_DEVELOPMENT_ENABLED conguration seing.

1. Double-click Conguration Seings in  Conguration > Site Conguration .
2. Enter MOD_CP_DEVELOPMENT_ENABLED in the Key eld.
3. Click Search.
4. Select Yes in the Value eld.
5. Click Save.

Register Customer Portal Open Login with Facebook  
Registering your open login with Facebook provides the application IDs and secret keys for requesting customer
credentials for authentication.

1. Navigate to the Facebook for Developers Add a New App page.
2. Create a Facebook Login account, following the requirements until you see the ID and secret values.
3. In Oracle Service Cloud, locate the FACEBOOK_OAUTH_APP_ID conguration seing.
4. In the Value eld, enter the App ID from the Facebook registration page.
5. Locate the FACEBOOK_OAUTH_APP_SECRET conguration seings.
6. In the Value eld, enter the App secret key from the Facebook registration page.
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7. Click Save.
8. On the Facebook page, enter your site’s valid domain in the App Domain eld.

Note:  If the domain is not valid, authentication will fail.

9. Enter your site’s URL in the Website With Facebook Login.
10. Click Save Changes.

Register Customer Portal Open Login with Google  
Registering your open login with Google provides values for the GOOGLE_OAUTH conguration seings.

1. Navigate to the Google Developers Console.
2. Create a new application, following the Google requirements until you see the ID and secret values.
3. In Oracle Service Cloud, locate the GOOGLE_OAUTH_APP_ID conguration seing.
4. In the Value eld, enter the App ID from the Google page.
5. Locate the GOOGLE_OAUTH_APP_SECRET conguration seing.
6. In the Value eld, enter the App secret key from the Google page.
7. Click Save.

Register Customer Portal Open Login with Twier  
Registering your open login with Twier provides the application IDs and secret keys for requesting customer
credentials for authentication.

1. Navigate to the Twier Developer page.
2. Create a new application using the Twier requirements.

a. Set the website URL to point to your Oracle Service Cloud site.
b. Select Enable Sign in with Twier.
c. Set a Callback URL. The format for the Callback URL is <site_url>/ci/openlogin/oauth/callback/

twier/app/home/onfail/app/home/.
d. Set the Terms of Service URL. The format for the URL is <site_url>/app/home.
e. Set the Privacy policy URL. The format for the URL is <site_url>/app/home.
f. Select the Allow this application to be used to sign in with Twier checkbox.

g. On the Permissions tab, select Request email address from users.
You should see a unique App ID and App secret value.

3. In Oracle Service Cloud, locate the TWITTER_OAUTH_APP_ID conguration seing.
4. In the Value eld, enter the App ID from the Twier Application details page.
5. Locate the TWITTER_OAUTH_APP_SECRET conguration seings.
6. In the Value eld, enter the App secret key from the Twier Application details page.
7. Click Save.

Add Search Priority Words  
You can associate answers and documents with specic search terms ensuring the customer sees the information you
want them to.
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Search priority words let you associate a specic answer or document with specic search terms to ensure that the
answer (or document) will always be returned when a customer enters the search term. When you’ve assigned a
search priority word to an answer and the customer enters the search priority word, the answer is displayed in the
Recommended Links section on the Answers page.

1. Double-click Search Priority Words in  Conguration > Service > Knowledge Base .
2. Click New.
3. Type a name in Search Priority Word Name. This is not the search term itself, merely the identier for it.
4. In Keywords, type search terms, separating each one with a comma, semicolon, or line break.
5. Select Always Show, if you want the answer to appear in the Recommended Links section of the Answers page.
6. Choose how you want to associate the search priority word.

◦ Public Answer

◦ WWW Document

7. Enter the answer or document information you want to associate with the search priority words..

◦ To associate to an answer, enter the Answer ID for the answer.

◦ To associate to a document, enter the title and URL of the document.

8. Click Save and Close.

Add and Remove Answer Stopwords  
Incidents and answers are analyzed for suggested words you have indicated should not be searchable. Administrators
can modify this list of stopwords.

1. Open Answer Stopwords in  Conguration > Service > Knowledge Base .
2. Do one or more of these actions:

◦ Add words from the Suggested Additions list to the Active stopword list.
i. Select the stopwords you want to add to the list.

ii. Click >>.

◦ Add a stopword that is not in the Suggested Additions eld.
i. Enter the word in the eld at the top of the Active list on the right.

ii. Click Add New.

◦ Remove a stopword.
i. Click the word in the Active list.

ii. Click <<.
3. Click Save.

Run the Agedatabase utility to push your changes to the stopwords list.

Edit the Aliases Word List  
You can add aliases, or synonyms, to link terms that are specic to your industry or organization to similar search terms
your customers use.

1. Double-click File Manager  in  Conguration > Site Conguration .
2. In the Switch To drop-down menu, select wordlist les.
3. Click Download.
4. Click Save.
5. Select a location for the le.
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6. Open the saved le.
7. Enter each alias on a separate line using comma-delimited terms in uppercase text.

The search terms in the line can contain spaces, so you can use phrases as synonyms for the search word, for
example:
GPS,GLOBAL POSITIONING SYSTEM,NAVIGATIONAL SYSTEM

8. Save the edited le.
9. On the File Manager, click Browse.

10. Locate the edited le.
11. Click Open.
12. Click Go.
13. Click OK.

Related Topics
• Best Practices for Knowledge Base and Search Eectiveness

• Knowledge Base Search Tune-Up Checklist

Add an Answer Access Level  
Administrators can create custom answer access levels to restrict customer access to specied information.

1. Double-click Customizable Menus in  Conguration > Application Appearance .
2. Expand the System Menus folder.
3. Click Answer Access Levels.
4. Click New.
5. Enter the name of the answer access level in the Label eld.
6. If you do not want the answer access level to be visible on the interface, clear the Visible check box.
7. Click Save.

After you create custom access levels, you must assign the access levels to SLAs and assign SLAs to your customers. By
assigning an SLA to a group of customers (either organizations or contacts without an organization association), your
customers can view privileged answers from your customer portal pages.

Considerations for Allowing Duplicate Email Addresses  
Email address sharing lets you create accounts for multiple people who share one email address.

If you want to allow your customers to create multiple accounts using a single email address, you can enable email
address sharing. This can be useful for multiple sta members (for example, support@example.com) or family
members (hendersons@example.net).

CAUTION:  Email sharing is disabled by default. Consider the implications carefully before you enable it.

When email address sharing is disabled:

• Safeguards prevent the creation of duplicate contacts to protect your organization’s reputation when sending
mailings and surveys.
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• If you enable the feature and then later disable it, the application can develop conicts in the database when
duplicate email addresses are encountered.

When email address sharing is enabled:

• Some safeguards are removed.

• Customers aempting to create an account using an email address already in the knowledge base, trigger an
alternate account creation process.

a. Customer are sent to the Account Assistance page when they try to create an account using an email
address that is already in the knowledge base.

b. After entering the email address on the Account Assistance page, the email address receives a message
containing a list of known users and containing a link to create a new account entry.

c. Clicking the link takes the customer to the Finish Account Creation page, which asks for a user name and
password.

d. After submiing that information, the customer is directed to the Account Seings page, where
additional contact information can be entered.

Related Topics
• Email Address Sharing

Enable Email Address Sharing  
Administrators can enable address sharing by modifying a conguration seing.

1. Open Email Adddress Sharing in  Conguration > Database .
2. Select Enabled.
3. Click Save.

Dene Customer Password Requirements  
You can set password requirements that can strengthen customer passwords entered on the Log In, Create an Account,
and Change Password pages.

1. Double-click Contact Password Conguration in Conguration.
2. Edit the password requirements.
3. Click Save.

Overview of Finding Content on the Customer Portal  
You can use Customer Portal standard searching or indexing to return search results to customers.

Search engines nd the pages of your website from links from other sites and from links within your site. With the help
of sitemaps, search engines can also nd and index pages that are not part of your knowledge base, such as web pages,
PDFs, and Microsoft Word documents.
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Note:  Content in iFrames is not searched and indexed.

Indexing and searching of external documents are possible if you store the documents on a web server so they are
available through a URL. Typically, this limits les to those within the document root, CGI root, or FTP root directories.

By default, Sitemap is enabled and registered with Yahoo and Google.

The output URLs for your customer portal sitemap are:

• XML—https://<your_site>/ci/sitemap

• HTML—https://<your_site>/ci/sitemap/html

In addition to using Sitemap to provide beer spidering of your customer portal pages, Web Indexer can be pointed to
a page that uses Sitemap to beer index web pages outside of Oracle Service Cloud. Filters can guide the web spider
to follow only those hyperlinks that are within specied domains. During indexing, URLs are normalized to prevent a
document from being indexed more than once.

External documents are not re-indexed if they are edited. They will be re-indexed the next time the Keywordindexer
utility runs. The keyword indexes for external documents are stored in a le on the web server rather than in a database
table.

Congure the Web Indexer  
You can enable external document searching in the Conguration Wizard.

1. Double-click External Search Conguration in  Conguration > Service > Knowledge Base .
2. Follow the prompts in the Conguration Wizard to congure the Web Indexer.

Note:  To index a site using Sitemap, use the Sitemap URL as the root URL.

3. Click Save.

View External Search Logs  
You can view a list of external searches on your site using the External Search log.

1. Open Logs in  Conguration > Site Conguration .
2. Click External Search Logs.
3. Click Details for the log you want to view.

Turn O Customer Browser Cookie Use  
With the correct permissions, users can modify conguration seings to turn o cookies.

If you disable cookies, visit data is determined by URL parameters. You must dene in individual lines of code to prevent
new visits from being initiated each time the customer navigates away from a page.

1. Open Conguration Seings in  Conguration > Site Conguration .
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2. Locate the CP_COOKIES_ENABLED key in RightNow User Interface/Customer Portal/Login.
3. Set the Value eld to No.
4. Click Save.

Pass Visit Information in Custom Pages  
When your site has disabled cookies, you can pass visit information by modifying the page links.

1. Open the custom web site page.
2. Locate the link and add #rn:session# to the end of the page URL.

hps://<your_site>.custhelp.com/<custom_page>.html#rn:session#
3. Save and publish the page.

Maintain Visit Data in JavaScript Links  
You can use JavaScript to modify cookie header information and pass visit information.

1. Call the output of the $CI>session>setSessionData($data) function in your script and append it to the link.
2. If you are using a widget, you can create a variable for the result.

a. Create a variable.
$data['js']['session'] = /RightNow/Utils/Url::sessionParameter()

b. Reference the variable in the logic le.
link + data.js.session

Maintain Visit Data in PHP Links  
You can use php pages, templates, and widgets to modify cookie header information to pass visit data.

1. Add /RightNow/Utils/Url::sessionParameter() to the end of the link.
link .= /RightNow/Utils/Url::sessionParameter()

Accessibility in Customer Portal  
Several customer portal pages include a tag that is made visible to screen readers to meet accessibility requirements.

An o-screen <h1> tag is visible to screen readers using the rn_ScreenReaderOnly CSS class. This tag provides
accessible navigation using shortcut keys for customers who use screen readers. The content is not visible to sighted
users unless styles are disabled.

For information about creating content that is hidden to all users except screen readers, see the WebAIM article CSS in
Action: Invisible Content Just for Screen Reader Users.

Customer portal widgets are designed to comply with Oracle’s Accessibility Program. When you create custom widgets,
you are responsible for ensuring that your changes do not impact accessibility.
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Note:  If you choose to use an empty string for a label, some widgets will not include the asterisk that indicates
the input eld is required, even if you set the required aribute to true.

Customer Portal Conguration Seing Keys  
Customer Portal conguration seing keys have a default value. Their location and description are listed here.

Conguration Seing Key Description Default Value

ANS_NEW_INC_DURATION
RightNow User Interface/End-User
Interface/Answers/
 

Number of days that the solved count of new
answers will not be aged (reduced).

30

ANS_NOTIF_DURATION
RightNow User Interface/Contact
Services/Answer Notication/
 

The number of days that an answer update
notication request by an end-user will last
before being deleted.

0

ANS_PRV_ENABLED
RightNow User Interface/End-User
Interface/Answers/
 

Enables the Privileged Access feature, which
allows contacts and organizations to access
privileged access levels of answers when
searching the knowledge base.

No

ANS_SRCH_SUB_THRESHOLD
RightNow User Interface/End-User
Interface/Answers/
 

Species whether there should be an exception
to limiting answer results with a threshold on
matching.

No

ANS_SRCH_THRESHOLD
RightNow User Interface/End-User
Interface/Answers/
 

A threshold for returning answers. Only
answers that match at or above this threshold
are returned.

0

ANS_UPD_INC_DURATION
RightNow User Interface/End-User
Interface/Answers/
 

Number of days that the solved count of
updated answers will not be aged (reduced).

30

CP_404_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page that is loaded when customers
navigate to a non-existent page where a 404
error occurs.

Null

CP_ACCOUNT_ASSIST_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page where customers retrieve their user
name and password.

utils/account_assistance

CP_ANS_NOTIF_UNSUB_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page where customers unsubscribe from
an answer update notication.

account/notif/unsubscribe
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Conguration Seing Key Description Default Value

CP_ANSWERS_DETAIL_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page that displays answer details. answers/details

CP_CHANGE_PASSWORD_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page where customers can change their
password.

account/change_password

CP_CHAT_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page where customers can submit a
request for a chat session.

chat/chat_launch

CP_CONTACT_LOGIN_REQUIRED
RightNow User Interface/Customer
Portal/Login/
 

When enabled, requires contacts to be logged
in when access most pages or controls.

No

CP_COOKIES_ENABLED
RightNow User Interface/Customer
Portal/Login/
 

Denes whether the Customer Portal tries to
set cookies on a customer’s browser.

Note:  When enabled, a session
parameter is added on the initial page
load until the end user accepts the
create cookie request and is retained
until the cookie expires or is removed
from the end user’s system.

Yes

CP_FORCE_PASSWORDS_OVER_HTTPS
RightNow User Interface/Customer
Portal/Login/
 

This seing requires all logged in activity to
occur over HTTPS to provide protection from
password theft, phishing, and other security
threats.

Yes

CP_HOME_URL
RightNow User Interface/Customer
Portal/Pages/
 

The Home page for your customer portal home

CP_INCIDENT_RESPONSE_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page that displays individual questions
submied by customers when they select one
from a list of all their questions.

account/questions/detail

CP_LOGIN_URL
RightNow User Interface/Customer
Portal/Pages/
 

The page used to log in to your customer
portal.

utils/login_form

CP_LOGIN_COOKIE_EXP
RightNow User Interface/Customer
Portal/Login/
 

The number of minutes before the Customer
Portal login cookie expires.

60

CP_MAX_LOGINS The total number of customers that can be
logged in to your Customer Portal site.

0
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Conguration Seing Key Description Default Value

RightNow User Interface/Customer
Portal/Login/
 

CP_MAX_LOGINS_PER_CONTACT
RightNow User Interface/Customer
Portal/Login/
 

The total number of active, concurrent logins a
contact can have.

0

CP_PRODUCTS_DETAIL_URL
RightNow User Interface/Customer
Portal/Pages/
 

The location and le for generating product
detail URLs.

products/detail

CP_PUBLIC_PROFILE_URL
RightNow User Interface/Customer
Portal/Pages/
 

The location and le for generating public
prole URLs.

public_prole

CP_REDIRECT_HOSTS
Common/General/Security
 

Denes which outside hosts are allowed when
redirecting from Customer Portal pages.

Null

CP_SOCIAL_QUESTIONS_DETAIL_URL
RightNow User Interface/Customer
Portal/Pages/
 

The location and le for generating social
questions URLs.

social/questions/detail

CP_WEBSEARCH_DETAIL_URL
RightNow User Interface/Customer
Portal/Pages/
 

The Answer Details page used to display results
from the External Search page.

answers/detail

EU_CUST_PASSWD_ENABLED
RightNow User Interface/General/
End-User/
 

Enables the display of the Password eld on the
Customer Portal.

Yes

EU_SLA_VISIBLE
RightNow User Interface/General/
 

Allows SLA information to be visible in email
responses.

No

MOD_CP_DEVELOPMENT_ENABLED
Common/Oracle Products/
Modules/
 

Allows users to modify les through WebDAV,
 deploy changes, and reach the administrative
pages.

No

MYQ_ENABLED
RightNow User Interface/Contact
Services/Questions/
 

Includes a link in end-user emails that allows
end-users to link to the web page for their
incident and update their incident from the
Your Account Questions page.

Yes

MYQ_VIEW_ORG_INCIDENTS
RightNow User Interfaxe/Contact
Services/Questions/
 

Species which incidents a logged in user can
view.

0
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SA_AGE_FREQ
Agedatabase/Batch Processing/
SmartAssistant/
 

The approximate number of days before an
unused Answer solved count and link strengths
reduce to zero.

200

SA_RESULTS_COUNT_RATIO
Common/Knowledge Base/
SmartAssistant/
 

Species the ratio of results distribution by
document types.

60A:40S

SA_SOLVED_WEIGH_PREF
Common/Knowledge Base/Answer
Search/
 

The display preference of calculated solved
counts.

2

SA_USE_SOCIAL_PROD_CAT_FILTER
Common/Knowledge Base/
SmartAssistant/
 

Species the lter to be used in the
SmartAssistant GetSmartSuggestion query.

0

SEARCH_RELEVANCE_FOCUS
RightNow User Interface/End-User
Interface/Answers/
 

The degree of conceptual matching between
the search query and results using the learned
topics from within the knowledge base.

0

SRCH_ATTACH_WEIGHT
Common/Knowledge Base/Answer
Search/
 

The value used in calculating the search score
for words used in le aachments of answers.

4

SRCH_BODY_WEIGHT
Common/Knowledge Base/Answer
Search/
 

The value used in calculating the search score
for words used in the Answer eld of answers
and the thread entries of incidents.

4

SRCH_CAT_WEIGHT
Common/Knowledge Base/Answer
Search/
 

The value used in calculating the search score
for words used in the Category eld of answers.

50

SRCH_DESC_WEIGHT
Common/Knowledge Base/Answer
Search/
 

The value used in calculating the search score
for words used in the Question eld of answers.

30

SRCH_KEY_WEIGHT
Common/Knowledge Base/Answer
Search/
 

The value used in calculating the search
score for words used in the Keywords eld of
answers.

50

SRCH_PROD_WEIGHT
Common/Knowledge Base/Answer
Search/
 

The value used in calculating the search score
for words used in the Product eld of answers.

50

SRCH_SUBJ_WEIGHT The value used in calculating the search score
for words used in the subject of both answers
and incidents.

45
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Common/Knowledge Base/Answer
Search/
 

SSS_DISCUSSION_SITEMAP_ENABLE
RightNow Common/Social Self
Service/Genera/
 

Enables community content, end-user
questions and discussions, to be included in the
interface’s Sitemap XML.

Yes

VISIT_INACTIVITY_TIMEOUT
RightNow User Interface/General/
Security/
 

The number of minutes a customer can be
inactive on the Customer Portal without
needing to log in again.

30

VISIT_MAX_TIME
RightNow User Interface/General/
Security/
 

The maximum number of minutes a customer
web visit can last before and new visit and new
session ID are generated.

240

WIDGET_INSTALLATION_HOSTS
RightNow User Interface/Customer
Portal/Syndicated Widgets/
 

The external hosts allowed to install syndicated
widgets.

Null

Customer Portal File Naming Conventions  
Customer portal les follow a standard naming convention.

File naming conventions
• Use upper or lowercase alphanumeric characters and the underscore symbol.

• Must begin with a leer or an underscore.

• Paths are not case-sensitive. A mix of upper and lowercase characters is allowed but ignored.

Note:  The native WebDAV client in an English version of Windows does not handle le names that contain
multi-byte characters.

CSS and JavaScript les
To avoid naming conicts with any custom les you create, these les are namespaced with an rn_ prex.

Customer Portal Folder Structure  
The Customer Portal incorporates an intuitive, easy-to-navigate le structure that lets you clearly identify the les you
can edit.
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Folder and le location Description

/core/ You cannot add or remove les in this folder. You cannot
edit the names of the folders or les.

/core/assets/ Contains all web assets used by the Customer Portal
Administration site.

/core/assets/debug-js/ Contains all JavaScript debug assets used by the
Customer Portal Administration site.

/core/assets/default Contains the CSS, images, and themes for the pages,
templates, and widgets in the reference implementation.

/core/assets/ejs/ Contains the CSS, images, and themes for the pages,
templates, and widgets in the reference implementation.

/core/assets/images/ Contains the CSS, images, and themes for the pages,
templates, and widgets in the reference implementation.

/core/assets/thirdParty/ Contains the CSS, images, and themes for the pages,
templates, and widgets in the reference implementation.

/core/framework/ The core of the Customer Portal code base. Contains all
view les for the standard pages, templates, and view
partials. It also contains les and information about
version changes, controllers, libraries, models, and
utilities.

/core/widgets/ Contains the les for all standard widgets, including
controllers, views, CSS, images, logic, and YAML
information les. You can use these les to view the code
for the standard widgets.

/customer/ Contains all the Customer Portal les you can modify.
Even if you don’t stage and promote these pages, changes
you make may aect the look and function of your
production pages.

/customer/assets/ Contains the assets you can add, edit, and delete. Assets
include all les for your customer portal that are not
pages, templates, or widgets, including CSS, JavaScript,
images, video, and other rich web media. You can add,
remove, edit, and execute les and add subfolders to this
folder.

/customer/assets/css/ Contains the assets you can add, edit, and delete.

/customer/assets/images/ Contains the assets you can add, edit, and delete.

/customer/assets/themes/ These les are used strictly by the development les.
When you stage the development pages, these les are
copied to a time-stamped folder in the staging directory
and called from that folder. The themes you develop are
kept in this isolated sandbox. The themes are applied to
your production site only when you promote the staged
les into production.

/customer/assets/feedback/ These les are used strictly by the development les.
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/customer/assets/other/ Contains text les.

/customer/assets/default/ Contains default versions of the asset les provided in the
reference implementation.

/customer/development/ This is your working folder. It contains all templates and
pages to create and update your customer portal.

/customer/development/cong/ Contains les to dene model extensions, hooks that
extend functionality, mappings to convert page names
from previous frameworks to the current one, and search
source model extensions. You can edit these les, but you
cannot delete them.

/customer/development/hook.php Lets you dene a PHP array of functions that is executed
before and after the API calls of your choice.

/customer/development/mapping.php Redirects page requests and denes parameter mapping
when you are migrating from Customer Portal Framework
Version 1 (Classic or November 07 end-user interface).

/customer/development/controllers/ Contains a customer controller le, AjaxCustom.php,
which provides sample code that you can edit. You
cannot delete or rename this le. You can create and add
additional controller les to this folder.

/customer/development/errors/ Contains two PHP scripts (error_general.php and
error_php.php) used to display customized error pages.
Besides customizing the appearance of these pages, you
can also use information provided by the customer portal
to provide more specic information to customer than the
standard 404 error page. You can edit these les, but you
cannot add any les to this folder.

/customer/development/helpers Contains the sample_helper.php le and can be used for
storing PHP utility function les.

/customer/development/javascript Contains a single javascript le, autoload.js, which you
can edit. You cannot delete or rename this le. In the
reference implementation, the le contains no code.
When you add content to it, it will automatically load on
every page.

/customer/development/libraries/ Contains sample.php le and can be used for storing
singleton PHP class les.

/customer/development/models/ Contains three sample model les: /custom/
extendedsample.php, /custom/mysocialsearch.php,
and /custom/sample.php.

/customer/development/views/ Includes all display les that do not contain logic.

/customer/development/views/admin/ Pages are used to display answer previews on the Service
Console.

/customer/development/views/pages/ Contains all customer portal pages.
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/customer/development/views/templates/ Includes thestandard.php—used for the reference
implementation pages—and the agent.php—for
previewing a guide on the Oracle Service Cloud
administration interface.

/customer/development/views/partials/ Contains custom view partials.

/customer/development/widgets/ A folder for your custom widgets.

/customer/error/ This folder can contain only the reference implementation
error pages listed in this table.

/customer/error/splash.php You can display this page when your site is being
upgraded.

/customer/error/error404.html Static HTML page displayed when an HTTP 404 Not
found error code is returned.

/customer/error/error413.html Static HTML page displayed when an HTTP 413 Request
entity too large error code is returned.

/customer/error/error500.html Static HTML page displayed when an HTTP 500 Internal
server error code is returned.

/generated/ Mirrors the structure of the development folder. You
cannot add, edit, or delete the les in this folder.

/generated/production/ Contains the staged les that have been promoted into
production. These les are visible to your customers.

/generated/backup/ Contains the original source code from the previous
promoting activity.

/generated/staging/ Contains the development les that you have staged
through the Service Console or the Customer Portal
Administration site. Your customers cannot see these les.

/generated/backup/ Contains the original source code from the previous
staging activity.

/generated/themes/ Copied from your development site when you stage the
development pages.

/logs/ Contains logs for every stage, promote, and rollback
operation performed on your site. It also contains a log of
who changed Customer Portal les and when.

Customer Portal Reports  
You can nd customer portal reports in the Reports explorer, often found in the Analytics navigation list.
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Referring Sites Public Reports/Service/Site
Reports/Customer Portal/

The percentage of visits by sites that
referred customers to your site.

Visits by Browser Public Reports/Service/Site
Reports/Customer Portal/

The percentage of visits by browser
type.

Visits by Browser and Operating
System

Public Reports/Service/Site
Reports/Customer Portal/

The percentage of visits by browser
and operating system.

Visits by Operating System Public Reports/Service/Site
Reports/Customer Portal/

The percentage of visits by operating
system.

Visits by Page Set Public Reports/Service/Site
Reports/Customer Portal/

The percentage of sessions that
accessed each page set.

Visits by Time Public Reports/Service/Site
Reports/Customer Portal/

The number of visits that occurred
during each dened unit of time as
well as a percentage of visits per time
unit.

Aging Discussions Public Reports/Service/Community
Self Service/Activity/

A list of discussions that do not have
comments or best answers.

Discussion Comment Details Public Reports/Service/Community
Self Service/Activity/

A list of comments with their question
and comment IDs, associated product
or category, title, and date created. It
also identies comments marked as
best answers as well as ratings and
ags.

Discussion Question Details Public Reports/Service/Community
Self Service/Activity/

A list of discussion questions with
their IDs, associated product or
category, title, date created, and
author. It also includes number of
comments, best answers, ratings, and
ags.

Discussion Responsiveness Public Reports/Service/Community
Self Service/Activity/

A list of discussions sorted by the
number of comments and response
time.

Community Category Subscriptions Public Reports/Service/Community
Self Service/Subscription/

A list of subscribers to community
content for each category.

Community Product Subscriptions Public Reports/Service/Community
Self Service/Subscription/

A list of subscribers to community
content for each product.

Community Subscribers by Question Public Reports/Service/Community
Self Service/Subscription/

A list of discussion questions and
community members who are
subscribed to each.

Community Subscribers by User Public Reports/Service/Community
Self Service/Subscription/

A list of individual users and
the discussion content they are
subscribed to.

Discussion Question Subscriptions Public Reports/Service/Community
Self Service/Subscription/

A list of community discussions,
the product or category they are
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associated with, and the number of
subscribers to each discussion.

Top Categories by Comments Public Reports/Service/Community
Self Service/Top/

The categories that have the highest
number of new comments.

Top Categories by Questions Public Reports/Service/Community
Self Service/Top/

the categories that have the highest
number of new questions.

Top Comments by Rating Public Reports/Service/Community
Self Service/Top/

The comments with the highest
ratings.

Top Products by Comments Public Reports/Service/Community
Self Service/Top/

The products that have the highest
number of new comments.

Top Products by Questions Public Reports/Service/Community
Self Service/Top/

The products that have the highest
number of new questions.

Top Questions by Rating Public Reports/Service/Community
Self Service/Top/

The questions with the highest
ratings.

Top Users by Comments Public Reports/Service/Community
Self Service/Top/

Users who have contributed the
highest number of comments.

Top Users by Questions Public Reports/Service/Community
Self Service/Top/

Users who have contributed the
highest number of questions.

Registrations Trend Public Reports/Service/Community
Self Service/Users/

The trend of new community user
registrations.

User Details Public Reports/Service/Community
Self Service/Users/

A list of community users. Includes
display name, email address, full
name, organization, date the account
was created, their status, and the
number of questions, comments,
question and comment ratings, and
best answers.

Discussion Comments with No Author Common/Site Administration/
Community Self Service/

A list of discussion comments with no
authors assigned to them.

Discussion Questions with No Author Common/Site Administration/
Community Self Service/

A list of discussion questions with no
authors assigned to them.

Customer Portal Page Sets  
The Customer Portal contains sets of pages viewable from the Customer Portal Administration site.

File location Type of le Description

/cp/customer/development/views Development Files you work with when you want
to make changes to your customer
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File location Type of le Description

portal. These les are not visible to
your customers.

/cp/customer/development/
widgets/custom

Development Files you add or edit to change
custom widget functionality. These
les are not visible to your customers.

/cp/generated/staging Staging Files you’ve compiled and optimized
to look and perform as they will on
the production site. These les are not
editable. These les are not visible to
your customers.

/cp/generated/production Production Files you have promoted from
staging. These les are visible to your
customers.

/cp/core/framework/views Reference implementation Default, read-only les that make up
the original customer portal reference
implementation. You should remove
pages that your site does not use.

/cp/core/widgets Reference implementation Default, read-only les that make up
the original customer portal reference
implementation.

Customer Portal Template and Page Set  

Overview of the Standard Page Set  
You can congure the standard page set included in the reference implementation.

The standard page set contains a set of standard pages that lets your customers:

• Search for information in your knowledge base and from your community.

• View answers and community discussions.

• Submit questions to your support sta and community.

• Comment, rate, and ag community discussion content.

• Update their contact and community prole information.

• Moderate community discussions and users (for those with moderation permissions).

Note:  The reference implementation contains pages that you might not use, such as the mobile page set,
basic page set, community pages, and chat pages. Even if you do not use these features, the pages remain
available on your customer portal and it is possible that your customers may stumble upon them. You should
remove any pages that you do not use in your site.
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Overview of the Customer Portal Standard Template  
The reference implementation standard Customer Portal pages are built on a standard template. You can customize
these les for your organization’s needs and business practices.

The template for the reference implementation of the Customer Portal includes a set of widgets that are contained
in the header and footer to control navigation, search, login, product or category selection, and page set selection
functionality and the Oracle logo.

CAUTION:  The behavior of the reference implementation may not correspond to the descriptions in this
section if you have changed the default conguration seings.

These widgets are not rendered on a page, but provide specic functionality.

• BrowserSearchPlugin—This widget outputs a link to a browser search engine plug-in. The link is automatically
detected by web browsers, and the widget tells the browser what information to send to the search engine so
the site can be searched directly from the browser’s search bar.

• ClickjackPrevention—This widget prevents pages from loading in an iFrame or frameset, which prevents your
customers from clicking a concealed link.

• CapabilityDetector—This widget detects capabilities of your customers’ browsers. When a customer with
no or limited JavaScript capabilities tries to access a standard or mobile page, a link to the basic page set
appears, advising them to switch to the basic format for a beer experience. When a customer with JavaScript
capabilities accesses the basic page set, a notice appears to encourage them to switch to the standard page set.

Related Topics
• Creating a Custom Template (video)

• Changing a Page Template (video)

Edit Customer Portal Files  
With the right permissions, users can edit customer portal les to customize their site.

You must enable the MOD_CP_DEVELOPMENT_ENABLED conguration seing before you can make changes to your
development site, which means it must be enabled in order to make changes to the customer portal. If you do not
enable this seing, your customer portal will use the out-of-the-box reference implementation, and it cannot be edited.

1. Download the le to a local network location where you can access and open the le.
2. Edit the le as described in the procedure for that le, and then save the le.

We’re assuming that you’re working with the templates and pages in your development folder.
3. Upload the le to the server.
4. View and verify your changes on your development site.
5. Stage the pages from the administration interface or the Customer Portal Administration site.
6. Promote the staged pages into production.
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Related Topics
• Stage Customer Portal Pages

• Promote Customer Portal Pages

How Customer Portal Handles Question Marks in a URL  
The Customer Portal does not use query string parameters within URLs.

When question marks are encountered in a URL, the content in the query string is ignored and the page is rendered as if
the content is not in the URL. Product and category values in the search URL use subproduct and subcategory IDs.

For example, when product 130 is the parent of 138 and 138 is the parent of 131 (130 > 138 > 131), if all the products are
visible by the end-user, the value is reduced to 131.

Although they are not used in the URLs, you can still access the values stored in the query string. The PHP superglobal
$_GET array is populated with any query string key/value pairs that are found.

iFrame Security Issues  
Because using iFrames is not a best practice, the reference implementation includes a removable widget that prevents
your customer portal from being presented in an iFrame.

The use of iFrames can pose several issues. Search engine optimization (SEO) is problematic because content in
iFrames is not indexed by web crawlers. As a result, search engines will not display your knowledge base content to
customers who are searching for specic information. Security is also a concern in iFrames because clickjacking—that
is, misleading your customers into clicking a concealed link—is possible.

An additional consideration against the use of iFrames is the inability to set cookies in Internet Explorer 11. Although
your customers can unblock third-party cookies, requiring them to do so is not an optimal customer experience.

Related Topics
• Remove ClickjackPrevention from the Template

Customer Portal Framework Versioning  
The Customer Portal uses versions that apply a varying degree of change to the framework.

The Customer Portal version is independent of the Oracle Service Cloud release version, allowing you to upgrade to
newer versions of Oracle Service Cloud while leaving your customer portal site untouched. This gives you control to
migrate to a new Customer Portal framework when it’s convenient for your schedule. Each area of your customer portal
can use a dierent version of framework.

The Customer Portal uses three levels of versions: major, minor, and nano. Each version level implies a varying degree
of change to the framework. The version numbering scheme follows a paern such as 3.1.4.

• major—A major version change usually involves a fundamental change in a core component of the Customer
Portal and will require work on your part to migrate from one version to the next. Major version changes are
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indicated by a change to the rst digit of the version number (for example, the “3” in 3.1.4). You have complete
freedom to decide whether you want to migrate to the new major version or remain on your current version.

• minor—A minor change is not backward compatible. These changes may or may not aect you, depending
on the area and extent of the change and how it impacts your customizations. You have the choice of opting
in to the change rather than risking the possibility of breaking any of your custom code through an automatic
update. Minor version changes are indicated by the second digit in the version number, for example, the “1” in
3.1.4.

• nano—Nano changes are fully backward compatible. Theses changes will be applied automatically to your
customer portal code with no impact to your site. Your site will always have the most current nano version of
the framework being used by your customer portal, giving you the benet of enhancements and bug xes
without having to do any work to consume them. Nano changes are indicated by the third digit of the version
number, that is, the “4” in 3.1.4.

Dependency checks are run when you select a version update to ensure that your Oracle Service Cloud application
supports the selected customer portal framework. Dependency checks also let you know if any of your current widgets
must be migrated in order to function on the newer framework.

Related Topics
• Display Widget Versions

Overview of Message Bases in Customer Portal  
Many widgets and page headings use message bases, which are unique text strings that support internationalization.

You can identify message bases in Customer Portal code because they use an rn:msg#...# tag. The label between the
# symbols points to the specic message base to be used. When you reference a message base in the code, the page
automatically displays whatever text is associated with the message base. Message base labels appear in uppercase text
with the words separated by an underscore character.

For example, the code that generates the label on the Support Home tab is #rn:msg:SUPPORT_HOME_TAB_HDG#. You can
change the default label in one of three ways.

• Change the value of the message base—Every place that calls or uses the message base will use the value you
dened.

• Reference a dierent message base—If another message base uses the language you want, reference that
message base instead of the one that appears in the default code.

• Enter whatever message you want—If you want the change to appear only once and internationalization is not
a concern, you can simply enter whatever message you want into the page or widget code.

Change a Message Base Value  
This example shows how a user with the appropriate permissions can modify the value of SUPPORT_HOME_TAB_HDG.

1. Double-click Message Bases in  Conguration > Site Conguration .
2. In the Search window Key eld, enter SUPPORT_HOME_TAB_HDG.
3. Click Search.
4. Enter the new label in the Text eld.
5. Click Save.
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Reference a Dierent Message Base  
This example shows how you can reference the SUPPORT_HELP_HDG message base.

Locate the message base you want to use as a replacement. Message bases are listed in  Conguration > Site
Conguration > Message Bases . For this example we are using SUPPORT_HELP_HDG.

1. Open /views/templates/standard.php.
2. Locate the following line of code:

<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:SUPPORT_HOME_TAB_HDG#" link="/app/
#rn:config:CP_HOME_URL#" pages="home"/></li>

3. Edit the code to reect the name of the message base you want to use.
This code replaces the SUPPORT_HOME_TAB_HDG message base with the SUPPORT_HELP_HDG message
base:
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:SUPPORT_HELP_HDG#" link="/app/
#rn:config:CP_HOME_URL#" pages="home"/></li>

4. Save the le.

Use Custom Text Instead of Message Bases  
This example show how to change the default message base label to a custom value.

1. Open /views/templates/standard.php.
2. Locate this code.

<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:SUPPORT_HOME_TAB_HDG#" link="/app/
#rn:config:CP_HOME_URL#" pages="home"/></li>

3. Replace #rn:msg:SUPPORT_HOME_TAB_HDG# with the text you want to appear.
Your custom value doesn't need to include #rn:msg:.
<li><rn:widget path="navigation/NavigationTab" label_tab="Customer Care" link="/app/
#rn:config:CP_HOME_URL#" pages="home"/></li>

4. Save the le.

Add Navigation Tabs  
You can add new navigation tabs to the standard.php template le.

1. Open /views/templates/standard.php.
a. Copy the code lines for an existing navigation tab and paste it where you want the tab to appear in the

navigation.
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:SUPPORT_HOME_TAB_HDG#" link="/
app/#rn:config:CP_HOME_URL#" pages="home"/></li>

b. Edit the label_tab aribute to name the tab and the link aribute to specify the page you want to open
when the tab is clicked.
<li><rn:widget path="navigation/NavigationTab" label_tab="Chat" link="/app/chat/chat_launch/></li>

2. Save the le.
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Change Navigation Tab Labels  
You can change the labels for the two existing tabs, Support Home and Ask a Question, on the standard template.

1. Open /views/templates/standard.php.

◦ To change the Support Home tab label, enter the new label name over the content between the quotation
marks for the label_tab aribute.
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:SUPPORT_HOME_TAB_HDG#" link="/
app/#rn:config:CP_HOME_URL#" pages="home"/></li>

◦ To change the Ask a Question tab label, enter the new label name over the content between the
quotation marks for the label_tab aribute.
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#" link="/app/
ask" pages="ask, ask_confirm"/></li>

2. Save the le.

Add a Drop-down Menu to a Navigation Tab  
This example creates a new Answers tab with a sub-menu to demonstrate how you can create a drop-down menu for
navigation tabs on the standard.php template le.

1. Open /views/templates/standard.php.
a. Add the subpages aribute, subpages="#rn:msg:ANSWERS_HDG#, to the NavigationTab widget you want to

modify. List the page titles and paths in the aribute, WebSearch Indexing > /app/answers/web_list.
<rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ANSWERS_HDG#"
 link="/app/answers/list" pages="answers/list, answers/detail" subpages="#rn:msg:ANSWERS_HDG# > /
app/answers/list, WebSearch Indexing > /app/answers/web_list" />

2. Save the le.
If you do not get the results you expect, try replacing the NavigationTab.css le in cp/customer/assets/
default/themes/standard/widgetCss with the NavigationTab widget’s CSS from cp/core/assets/default/
themes/standard/widgetCss/NavigationTab.css.

Congure the SimpleSearch Widget  
You can add simple search functionality to any Customer Portal page.

The SimpleSearch widget is displayed conditionally and does not appear on pages that already contain a search eld,
such as Support Home, any of the search results pages, and the Public Prole page.

1. Open a template le and locate the block of code:

◦ /views/templates/standard.php
<rn:condition hide_on_pages="home, public_profile, results, answers/list, social/questions/list">
 <div class="rn_SearchBar">
 <rn:widget path="search/SimpleSearch" icon_path="" report_page_url="/app/results"/>
 </div>
</rn:condition>

◦ /views/templates/mobile.php
<rn:condition hide_on_pages="home, results, answers/list, social/questions/list, account/profile,
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 utils/create_account, utils/account_assistance, utils/login_form">
 <div class="rn_SearchBar">
 <rn:widget path="search/SimpleSearch" report_page_url="/app/results"/>
 </div>
</rn:condition>

2. Edit the code to congure the SimpleSearch widget:

◦ To remove the SimpleSearch widget from every page, remove the code you located.

◦ To display the SimpleSearch widget on every page, remove the opening condition statement
<rn:condition ...> and the closing condition statement </rn:condition> lines.

◦ To change the widget’s labels, add the label aribute using the form label="Your Custom Label Name".

◦ To set the focus to the search eld when a page opens, add the initial_focus aribute to the widget and
set the value to true.
<rn:widget path="search/SimpleSearch" icon_path="" report_page_url="/app/results"
 initial_focus="true"/>

◦ To open a page other than the default results page, change the report_page_url to a dierent page.
<rn:widget path="search/SimpleSearch" icon_path="" report_page_url="/app/social/questions/list"/>

3. Save the le.

Overview of the AccountDropdown Widget  
The AccountDropdown widget displays various account and login options, depending on the customer's status.

Customers who already have an account with your organization can log in to their account by clicking the Log In or Sign
up buon, which is generated with the AccountDropdown widget. They can also log in using the open login options
available through social media accounts, such as Facebook, Twier, Yahoo, and Google. Customers who do not have an
account can click the Create an Account link to enter information and set up an account.

Note:  Customers must have their browsers set to accept cookies or they will not be able to log in to the
customer portal.

The AccountDropdown widget contains these three widgets.

• LogoutLink—Creates the Logout option on the drop-down menu.

• UserInfoDialog—Opens the dialog that asks customers who have a user name but not a community display
name to enter a display name.

• LoginDialog—Opens the login window.

When a widget contains other widgets, you can use the aributes of the contained widgets in the widget denition. So,
for example, although the AccountDropdown widget does not include a redirect_url aribute to indicate the page users
should be redirected to when they log out, the LogoutLink widget does include that aribute. As a result, you can assign
the aribute to the AccountDropdown widget too.

Congure the AccountDropdown Widget  
Congure the AccountDropdown widget to modify what account details users can access.

1. Open one of these les and locate the AccountDropdown widget code.
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◦ /views/templates/standard.php

◦ /views/templates/mobile.php

There are four instances of the AccountDropdown widget on the template page.

- For users who are not logged in.
<rn:widget path="login/AccountDropdown" subpages="#rn:msg:ACCOUNT_OVERVIEW_LBL# > account/
overview"

- For logged-in users who do not have a community prole.
<rn:widget path="login/AccountDropdown" subpages="#rn:msg:ACCOUNT_OVERVIEW_LBL# > account/
overview,
#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL# >
 account/profile"/>

- For logged-in users with a community prole.
<rn:widget path="login/AccountDropdown" subpages="#rn:msg:ACCOUNT_OVERVIEW_LBL# > account/
overview,
#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL# >
 account/profile,
#rn:msg:PUBLIC_PROFILE_LBL# > #rn:config:CP_PUBLIC_PROFILE_URL#/user/
#rn:profile:socialUserID#"/>

- For logged-in users with a community prole who have moderator permissions.
<rn:widget path="login/AccountDropdown" subpages="#rn:msg:ACCOUNT_OVERVIEW_LBL# > account/
overview,
#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL# >
 account/profile,
#rn:msg:PUBLIC_PROFILE_LBL# > #rn:config:CP_PUBLIC_PROFILE_URL#/user/
#rn:profile:socialUserID#,
#rn:msg:MODERATION_LBL# > social/moderate/overview"/>

2. Edit the code to congure the AccountDropdown Widget.

◦ To change the widget’s labels, add the label aribute using the form label="Your Custom Label Name".

◦ To automatically open a request for a community user display name for users who do not have one, add
the display_on_page_load aribute to the last instance of the AccountDropdown widget and set it to true.

◦ To set the focus to the search eld when a page opens, add the initial_focus aribute to the widget and
set the value to true.

◦ To remove the open login providers from the LoginDialog widget that opens when the Log In or Sign Up
buon is selected, add the open_login_providers aribute to the AccountDropdown menu and set it to a
null value.

◦ To display only a select number of open login providers, add the open_login_providers aribute to the
AccountDropdown widget and specify the providers you want.

◦ To remove the password eld, add the disable_password aribute to the AccountDropdown widget and
set its value to true.

3. Save the le.

Congure the Template Footer  
You can customize the footer in the template to add site navigation links, a copyright statement, contact information,
and other elements.

1. Open /views/templates/standard.php.
2. Locate the footer code.
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<div id="rn_Footer" role="contentinfo">
 <div id="rn_RightNowCredit">
 <div class="rn_FloatRight">
 <rn:widget path="utils/RightNowLogo"/>
 </div>
 </div>
 </div>

3. Edit the code to customize the footer.
◦ To display a list of categories instead of the default list of products, add the data_type aribute to the

ProductCategoryList widget and set it to “categories,” and change the label_title aribute to “Categories.”
<rn:widget path="search/ProductCategoryList" report_page_url="/app/products/detail" 
data_type="categories" label_title="Categories"/>

◦ To change the default number of products or categories that are displayed, add the maximum_top_levels
aribute to the ProductCategoryList widget and set it to the number you want.
<rn:widget path="search/ProductCategoryList" report_page_url="/app/products/detail" 
maximum_top_levels="10"/>

◦ To display a specic list of products or categories, add the only_display aribute to the
ProductCategoryList widget and use the ID numbers, separated by commas, of the products or
categories you want to list.
<rn:widget path="search/ProductCategoryList" report_page_url="/app/products/detail" />

◦ To display an additional level of the product or category hierarchy, add the levels aribute to the
ProductCategoryList widget and set it to 2.
<rn:widget path="search/ProductCategoryList" report_page_url="/app/products/detail" 
levels="2"/>

◦ To add a copyright statement to the footer, add <p>&copy Copyright 2015 Global Wireless </p>
immediately after the line for the OracleLogo widget.

4. Save the le.

Customer Portal Themes  
Themes are created from CSS (cascading style sheet) les. Themes may also include graphics, JavaScript, ash
animations, and other types of les.

All reference implementation theme les are called from the /euf/assets/themes/standard and /euf/assets/
themes/mobile folders. Copies of theme les used in the reference implementation are also stored in /cp/customer/
assets/themes/standard and /cp/customer/assets/themes/mobile.

When you create custom themes, you must place them in the /cp/customer/assets/themes subfolder. The CSS used
for the theme must also be placed in the custom theme folder. If you try to stage development les containing theme
paths not associated with /cp/customer/assets/themes, you will see a warning in the deployment log.

Although all other les in the /cp/customer/assets/ folder are shared between the production and development
sites, the les in the /themes/ subfolder of /cp/customer/assets/ are used strictly by the development les. When
you stage the development pages, these les are copied to a time-stamped folder in the staging directory and called
from that folder. This keeps the themes you develop in an isolated sandbox that cannot be accessed by production
les. The themes are applied to your production site only when you promote the staged les into production. Any CSS
les that are referenced by a theme but not located in the /themes/ folder will be copied into a special directory in the
production copy of the theme when the staged les are promoted into production.

Read-only copies of the reference implementation asset les are available in the /cp/core/assets/default/themes/
standard and /cp/core/assets/default/themes/mobile folder. By selecting Reference Implementation on the View
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Site menu at the upper right of the Customer Portal Administration site, you can see exactly how the Customer Portal
appears using the default CSS les. You can also copy the les in this folder if you want to overwrite the changes you’ve
made and restore the reference implementation CSS.

Related Topics
• Create a Custom Theme (video)

RN Theme Tag  
You can dene multiple themes and write logic to select a theme at runtime based on any combination of database
variables, web visit variables, URL aributes, or other elements.

The RN Theme tag is used on a page or template to dene what theme should be used. If a page uses a template and
also denes a theme, the page theme takes precedence. Pages can specify more than one theme. If this is the case, the
page uses the rst theme unless the page code indicates otherwise.

Theme tags have two aributes: the location of the theme directory and one or more CSS les to be included on the
page. The reference implementation template, standard.php, uses the default theme, site.css, located in the /euf/
assets/themes/standard folder, as shown in this code.

<rn:theme path="/euf/assets/themes/standard" css="site.css"/>

You can copy the reference implementation CSS le and modify it to create a variety of themes that can be applied to
pages using the RN Theme tag.

Note:  Rather than specifying a specic YUI version number, you can substitute the value {YUI} at the
beginning of the le name to use the current YUI version, as shown in the preceding reference implementation
template code.

Related Topics
• Overview of Widget CSS Files

Create a Theme  
By copying the reference implementation CSS les, you can create your own theme.

1. Create a folder in /cp/customer/assets/themes.
2. Copy the les in /cp/customer/assets/themes/standard and paste them into the folder you created in.
3. In a text editor, open site.css from your new custom folder.
4. Edit the CSS le to customize your new theme.

◦ Make edits to modify the text, colors, or other aspect of your custom theme.

◦ If you want to add images, place the image les in /cp/customer/assets/themes/
[your_custom_folder]/images.

5. Save the le.

If you want to modify the widget presentation CSS to match the changes you made, make your changes to the
corresponding CSS le in /cp/customer/assets/themes/[your_custom_folder]/widgetCss.

1118

https://apexapps.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:13253


Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

Related Topics
• Creating Custom Themes (video)

Apply a Theme  
You can apply your own theme to a page or template.

1. Open the page or template le you want to apply a custom theme to.
2. Locate <rn:theme path="/euf/assets/themes/standard" css="site.css,.
3. Edit the path aribute for the RN Theme tag to specify the new theme. If you want to specify a dierent CSS le

for the theme to use, change the css aribute as well.
 <rn:theme path="/euf/assets/themes/custom_01" css="site_01.css,

4. Save the le.

Related Topics
• Applying a New Theme (video)

Customer Portal Page Meta Tags  
You can control Customer Portal functionality through page tags and page meta tags instead of writing PHP code.

You can use page meta tags on any Customer Portal page by adding the aribute name to the <rn:meta> tag.

Meta Tag Aribute Name Description

Account Session ID Required account_session_required Allows the page to be accessed only
by logged-in sta accounts. This tag
can also be used to create a custom
tab with a browser on an agent
desktop workspace.
 
This meta tag is used on the Guided
Assistant page so guides can
be previewed by sta members
who are designing guides on the
administration interface.
 

Answer Details answer_details Denes the page as an Answer Details
page, displaying it only if customers
have the required permissions.

Clickstream Tag clickstream Denes the type of page for
clickstream and page statistics
collection.
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Meta Tag Aribute Name Description

Force HTTPS force_hps Forces the page to use HTTPS when
CP_FORCE_PASSWORDS_OVER_HTTPS
is enabled.

Include Chat include_chat Indicates whether the page contains a
Chat application.
 
Denes whether the page includes all
required Chat JavaScript les.
 

JavaScript Module javascript_module Denes the JavaScript module that
should be loaded on the page.

Login Required login_required Species whether customers must be
logged in to view the page.

Page Title title Denes the title that appears on the
page.

Redirect If Logged In redirect_if_logged_in Species the page where customers
will be redirected if they are already
logged in.

SLA Failed Page sla_failed_page Indicates where customers are
redirected if they do not have the kind
of SLA specied in the SLA Required
Type page meta tag.

SLA Required Type sla_required_type Denes the type of SLA a customer
must have to view the page.

Social Moderator Required social_moderator_required Indicates a page that can be accessed
only by a social user with discussion
moderation permissions.

Social User Moderator Required social_user_moderator_required Indicates a page that can be
accessed only by a social user with
discussion moderation and social user
moderation permissions.

Template template Identies the template the page uses.

Add Page Meta Tags  
This example demonstrates using a page tag on the standard template with a chat application to display an error
message to customers who do not have a chat SLA.

1. Open a template le and locate the <rn:meta> tag.

◦ /views/templates/standard.php

◦ /views/templates/mobile.php

2. Edit the <rn:meta> tag to include the sla_failed_page aribute.
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<rn:meta title="Gold Service Chat Customers" template="standard.php" 
clickstream="chat_request" include_chat="true" sla_required_type="chat" 
sla_failed_page="/app/error/error_id/2" />

3. Save the le.

Related Topics
• Customer Portal Page Meta Tags

Require Login on Customer Portal Pages  
You can require your customers to log in before they can access any or all of your customer portal pages.

By seing the login_required aribute on the template to true, all pages that use the template will also require login.
However, you don’t want to require customers to log in before they click the Log In or Sign Up link. To prevent requiring
login when it doesn’t make sense, the default pages for logging in, reseing passwords, and creating accounts, as well
as the error pages have the login_required page meta tag set to false, which overrides the template seing.

By default, the Account Overview page, accessed by clicking the Your Account tab, requires login, but you may also want
to require customers to log in before they can view answers in your knowledge base. Or you may decide to require login
for your entire customer portal page set.

Note:  If you want to keep the answers in your knowledge base from being available to the general public, you
must require login on both the answers list and answer details pages. If both pages do not have the same login
requirement, a warning will appear when you stage and promote your customer portal. The most secure way
to do this is to require login on all pages of your customer portal by requiring login on the template.

1. Open /views/templates/standard.php.
2. Locate the <rn:page_content/> line and add the following line of code immediately above it.

<rn:meta login_required="true"/>

3. Save the le.

Require an SLA on the Ask a Question Page  
You can require that your customers have an SLA (service level agreement) before they can access any or all of your
customer portal pages.

1. Open one of the Ask a Question page les and locate the <rn:meta> tag:

◦ /views/pages/ask.php
<rn:meta title="#rn:msg:ASK_QUESTION_HDG#" template="standard.php" clickstream="incident_create"/>

◦ /views/pages/mobile/ask.php
<rn:meta title="#rn:msg:ASK_QUESTION_HDG#" template="mobile.php" clickstream="incident_create"/>

2. Edit the code to change the login_required page meta tag to "true" and add the sla_required_type and
sla_failed_page meta tags.
<rn:meta title="#rn:msg:ASK_QUESTION_HDG#" template="standard.php" clickstream="incident_create"
login_required="true" sla_required_type="incident" sla_failed_page="/app/error/error_id/2" />

3. Save the le.
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Content Placement on Customer Portal Pages  
You’ll use page tags to position information on a page.

These tags control the placement of content on Customer Portal pages.

• Page Title—Place this tag where you want the page title to appear when the page and template are merged.
<title>
 <rn:page_title/>
</title>

• Head Content—Place this tag between the opening and closing head tags where the page’s head content will
be inserted. This content is a combination of widget CSS les, page CSS les, no-cache meta tags, and any
other content added to the head by widgets (using the $this->addHeadContent function). When the page is
rendered, global CSS is loaded rst, followed by any other page/widget level CSS. As a result, the correct CSS
hierarchy is preserved.
<head>
 <rn:head_content/>
</head>

• Page Content—Place this tag where you want the page’s content to be inserted when the page and template are
merged.
<div>
 <rn:page_content/>
</div>

When you use page tags, do not try to comment them out with HTML commands. Comments do not stop widgets from
rendering and may cause rendering problems. They may also stop other tags from being converted. If you want to test a
page without a page tag, remove it instead of commenting it out.

Display Database Content on a Customer Portal Page  
This example uses the Answer Details page to demonstrate how to use page tags to output answer information from
the database.

Locate the names of the elds you wish to use in Business Objects on the Customer Portal Administration site. Make
note of how to label them in the code.

The <rn:field> tag has two aributes.

• highlight—Highlights content that matches the keyword parameter in the URL.

• name—Identies the business object type and eld to be displayed.

Pound tags (#rn:) are also included in page tags and let you display or output language codes, message base labels,
visit parameters, conguration seing values, session parameters, community tokens, URL parameters and parameter
values, and widget aribute PHP code.

1. Open the Answer Details page, /views/pages/answer/detail.php.
2. Locate this code:

<div class="rn_PageTitle rn_RecordDetail">
 <rn:widget path="navigation/ProductCategoryBreadcrumb"/>
 <h1 class="rn_Summary" itemprop="name"><rn:field name="Answer.Summary" highlight="true"/></h1>
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 <div class="rn_RecordInfo rn_AnswerInfo">
 #rn:msg:PUBLISHED_LBL#
 <span itemprop="dateCreated"><rn:field name="Answer.CreatedTime" /></span>
 &nbsp;&nbsp;|&nbsp;&nbsp;&nbsp;
 #rn:msg:UPDATED_LBL#
 <span itemprop="dateModified"><rn:field name="Answer.UpdatedTime" /></span>
 </div>
 <rn:field name="Answer.Question" highlight="true"/>
</div>

3. Notice the <rn:field> tags used to display the answer summary, the created and updated dates, and the answer
description.

4. Add other database elds using the same format.
5. Save the le.

How You Apply Common Aributes to Multiple Widgets  
Page tags let you create a set of widget aributes that can be referenced by multiple widgets.

You can use the <rn:container> tag in one of two ways.

• As a wrapper around a group of widgets—the tag denes the values for one or more widget aributes that all of
the enclosed widgets share.

• As a widget aribute that references the aribute-value denitions of the container—you assign the container
an ID value and then dene aributes within the container. All widgets that reference the container ID then
inherit the other aributes dened in the container.

Related Topics
• Use the rn:container Tag as a Wrapper

• Use the rn:container Tag as a Widget Aribute

Use the rn:container Tag as a Wrapper  
This example uses the Answers page to demonstrate using the container tag as a wrapper around a group of widgets to
applying common aributes to multiple widgets.

Each of the widgets that requires a report, use report ID 176 because they are all enclosed within the <rn:container
report_id="176"> tag.

1. Open the Answers page, /views/pages/answers/list.php.
2. Locate the rn_SearchControls tag.

<div class="rn_SearchControls>...</div>

3. Replace that tag with this code:
<rn:container report_id="176">
 <div class="rn_Hero">
 <div class="rn_HeroInner">
 <div class="rn_SearchControls">
 <h1 class="rn_ScreenReaderOnly">#rn:msg:SEARCH_CMD#</h1>
 <form onsubmit="return false;">
 <div class="rn_SearchInput">
 <rn:widget path="search/KeywordText" label_text="
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 #rn:msg:FIND_THE_ANSWER_TO_YOUR_QUESTION_CMD#" initial_focus="true"/>
 </div>
 <rn:widget path="search/SearchButton" force_page_flip="true"/>
 </form>
 <div class="rn_SearchFilters">
 <rn:widget path="search/ProductCategorySearchFilter"/>
 <rn:widget path="search/ProductCategorySearchFilter" filter_type="Category"/>
 </div>
 </div>
 </div>
 </div>
</rn:container>

4. Note the code identifying the report: <rn:container report_id="176">. You can change the report id to require
all widgets in the tag to use a dierent report.

5. Save the le.

Use the rn:container Tag as a Widget Aribute  
This example demonstrates how you could use code to dene the container.

When a container is dened this way, any widget on the page can then use the rn_container_id aribute as a shortcut
for assigning all the aributes dened in the container to the widget that calls the container in its code. If the widget
code specically denes an aribute that is dened in the container, the value for the aribute in the widget code
overrides the value in the container.

1. Open the page you want to add the widget aribute to.
2. Add this code to the page: <rn:container rn_container_id="1" report_id="196" per_page=2"/>.

Although the value for the rn_container_id is an integer in this example, it can be any string.

Note:  The prex rnc_ is reserved by Customer Portal and cannot be used in string values.

3. Add this code to the page.
<rn:widget path="reports/Multiline" label_text="" initial_focus="true" rn_container_id="1"/>
<rn:widget path="reports/Paginator" icon_path="images/icons/search.png" rn_container_id="1"/>

Each of these widgets uses a report_id value of 196 and a per_page value of 2 because those are the values
assigned to the aributes in the container denition.

4. Save the le.

The Page Condition Tag  
Page condition tags let you hide or display content based on whether set conditions are met.

The code structure for the RN Condition page tags looks like this.

<rn:condition attribute="value">
 [Content here is displayed only if the specified condition is met]
</rn:condition>

These situations can control whether information is displayed or not.

• The customer’s login status

• Whether the customer is logged in with pass-through authentication
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• The specic page where content is placed

• The number of answers viewed by a customer

• The number of searches performed by a customer

• The amount of time that has elapsed since an incident was solved

• The customer’s SLA

• The language of the interface

• The value of a conguration seing

• The value of a URL parameter

• Chat availability

• The customer’s community user status

The conditional page tag also includes an RN Condition Else tag to provide if/then logic for displaying or hiding content.

Note:  You should consider the usability issues of conditionally hiding and exposing page navigation before
implementing page conditions. Particularly for customers using screen readers, the presence of a new
navigation tab may not be evident when the conditions that trigger its appearance have occurred.

Logged In Condition  
If the customer is logged in, the content within the condition tags is displayed on the page.

The standard template uses the Logged In page condition tag to display the Welcome Back message and customer’s
name in the upper right corner of the page.

Note:  Although you can use the Logged In page condition tag to show or hide the entire contents of a page, it
might be more ecient to use the Login Required page meta tag instead.

External Login Used Condition  
When customers log in to your customer portal using pass-through authentication (PTA), the input elds on the
Account Seings page are set to read-only by default.

If you want to let PTA customers change just one or two elds, you can  add an aribute to the widget code for the
individual input elds.

However, if you have a block of input elds that you want to let customers edit, you can enclose them in condition tags
rather than editing each widget’s code separately. Use <rn:condition external_login_used="true"> before the rst input
widget in the block of input elds, and add the closing condition tag (</rn:condition>) after the last widget.
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Hide or Show on Pages Conditions  
The Hide on Pages tag lets you specify the pages on which the content between the tags is hidden. The Show on Pages
tag lets you specify the pages where the content appears.

The reference implementation template uses these tags to prevent the SimpleSearch widget from appearing on pages
that already have a search eld, namely the Home page, Search Results pages, and the Public Prole page.

Answers, Questions, and Content Viewed Conditions  
You might want to use these tags to require your customers to rst view existing answers and/or community
discussions instead of automatically submiing a question to your support team.

The Answers Viewed tag lets you hide content until the customer has viewed the number of answers you specify.
The Questions Viewed tag hides content until the specied number of community discussions has been viewed. The
Content Viewed condition allows a value that adds the number of answers and questions viewed.

Searches Done Condition  
The Searches Done condition tag hides content until the customer meets the search requirements.

This page condition tag hides content until the customer has conducted the specied number of searches. If you want
to use this for displaying the Ask a Question tab, it’s beer to Display the Ask a Question Page Based on User Actions.

Note:  The RN Condition tag identies a search only when a page is turned or refreshed. For example, assume
a customer conducts one search and reviews the list but does not click an answer or otherwise leave or refresh
the Answers List page. When the second search is made, the link you are hiding will not be displayed until
another page is opened or the current page is refreshed.

Incident Reopen Deadline Hours Condition  
You can dene content visibility based on incident closure.

This page condition tag lets you dene how many hours after an incident is closed that the content within the tags
remains visible. For example, the default Question Details page (the page that customers access by clicking one of their
questions on the Support History page) hides the section of the page that lets the customer update the question after
one week (168 hours). After that time has elapsed, the content is hidden and the Condition Else tag is used to display a
message that the question can no longer be updated.
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Hide Popular Published Answers for Customers without an SLA  
Use the page condition tag to hide content unless the customer has the specied SLA.

1. Open /views/pages/home.php.
2. Find <div class="rn_PopularKB">.
3. Add <rn:condition sla="incident" > on a separate line immediately above <div class="rn_PopularKB">.
4. Find <div class="rn_PopularSocial">.
5. Add </rn:condition>on a separate line immediately above <div class="rn_PopularSocial">.
6. Save the le.

Language In Condition  
You can display content based on the language dened in the page’s content-language meta tag.

The default Account Seings page on an English-language page displays the address elds in this order: Street, City,
Country, State/Province, and Postal Code. On pages that use Japanese, Korean, and Chinese languages, the order is
Postal Code, Country, State/Province, City, and Street. The use of this condition is demonstrated in this code from the
prole.php page.

<rn:condition language_in="ja-JP,ko-KR,zh-CN,zh-HK,zh-TW">
 <rn:widget path="input/FormInput" name="Contact.Address.PostalCode"
 label_input="#rn:msg:POSTAL_CODE_LBL#" />
 <rn:widget path="input/FormInput" name="Contact.Address.Country" />
 <rn:widget path="input/FormInput" name="Contact.Address.StateOrProvince"
 label_input="#rn:msg:STATE_PROV_LBL#" />
 <rn:widget path="input/FormInput" name="Contact.Address.City" />
 <rn:widget path="input/FormInput" name="Contact.Address.Street" />
<rn:condition_else />
 <rn:widget path="input/FormInput" name="Contact.Address.Street" />
 <rn:widget path="input/FormInput" name="Contact.Address.City" />
 <rn:widget path="input/FormInput" name="Contact.Address.Country" />
 <rn:widget path="input/FormInput" name="Contact.Address.StateOrProvince"
 label_input="#rn:msg:STATE_PROV_LBL#" />
 <rn:widget path="input/FormInput" name="Contact.Address.PostalCode" label_input="#rn:msg:POSTAL_CODE_LBL#"/
>
</rn:condition>

Cong Seing Check Condition  
You may want to display content based on the value of a conguration seing that was dened on the administration
interface.

The aribute for the Cong Seing Check condition is more complex than most other conditions. The format is:

 {CONFIG_BASE:CONFIG_SLOT} {OPERATOR} {VALUE}

The aribute includes these elements.

• CONFIG_BASE—One of these conguration bases in Oracle Service Cloud.

◦ Common (which corresponds to the Common folder on the Conguration Seings editor)
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◦ RNW (RightNow Common folder)

◦ RNW_UI (RightNow User Interface folder)

◦ RNL (Chat folder)

◦ MA (Outreach and Feedback)

Note:  The CONFIG_BASE element is not case sensitive.

• CONFIG_SLOT—The name of the conguration seing as it appears in the Conguration Seings editor. These
names are case sensitive.

◦ OPERATOR—The logical operator. Acceptable values are == (equals), != (not equal), > (greater than), <
(less than), >= (greater than or equal to), and <= (less than or equal to).

◦ VALUE—The value to compare the parameter to. Values include true, false, null, an integer, or a quoted
string.

For example, to set a condition that Chat is enabled, the aribute looks like this.

<rn:condition config_check="MOD_CHAT_ENABLED == true">

URL Parameter Check Condition  
The URL Parameter Check condition lets you display or hide content based on the value of a parameter in the page URL.

The standard Ask a Question conrmation page uses this condition to retrieve the incident’s reference number.

The aribute for this condition is more complex than most other conditions. The format is:

{URL_KEY} {OPERATOR} {VALUE}

These are the elements of the aribute.

• URL_KEY—The parameter key to be checked in the URL. For example, to check the keyword URL parameter,
enter kw for this value.

• OPERATOR—The logical operator. Acceptable values are == (equals), != (not equal), > (greater than), < (less
than), >= (greater than or equal to), and <= (less than or equal to).

• VALUE—The value to compare the parameter to. Values include true, false, null, an integer, or a quoted string.

For example, use this aribute to set a condition if the keyword parameter is “roaming.”

"<rn:condition url_parameter_check="kw == 'roaming'">

Display Alternate Content When Chat is Unavailable  
Use the Chat Available tag to determine whether the current time is within the chat operating hours and not a holiday.

1. Open /views/pages/chat/chat_launch.php.
2. Locate this code.

</rn:condition>
<rn:widget path="chat/ChatStatus"/>
<rn:widget path="chat/ChatHours"/>
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3. Add this code directly above the code you found in the previous step.
<rn:condition_else/>
[Content to be displayed when chat hours are not available]

4. Remove the chat availability status text by deleting <rn:widget path="chat/ChatStatus"/>.
5. Save the le.

<rn:condition_else/>
 [Content to be displayed when chat hours are not available]
</rn:condition>
<rn:widget path="chat/ChatHours"/>

Community User Statuses  
The community user statuses are used to control the content seen by discussion moderators and user moderators.

You may have content on your template or pages that you want to display to some community users but not others. For
example, the AccountDropdown widget’s menu options are conditional. Customers who are not community members
do not have the Public Prole option, while community users who are not moderators do not have the Moderation
option. Four status conditions exist.

• is_active_social_user—Community user with active status.

• is_social_moderator—Content moderator.

• is_social_user—Community user with archived or deleted status.

• is_social_user_moderator—Content and user moderator.

The Else Condition  
The conditional page tag includes an RN Condition Else to provide if/then logic for displaying or hiding content.

The RN Condition Else tag has no aributes and requires no closing tag. The code will follow this structure.

<rn:condition attribute="value">
[Content to be displayed if condition is met]
<rn:condition_else/>
[Other content to be displayed when condition is not met]
</rn:condition>

Standard Page Files  
Each standard customer portal page has a title that appears in your browser when the page is displayed, and each page
is also dened by its page name.

Page File Name Page Title and Description

account/change_password Change Your Password page—Allows customers to change their password.
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Page File Name Page Title and Description

account/overview Account Overview page—Provides an overview of account information, where customers can view the
questions they have submied, the notications they have subscribed to, and their service contracts.
The Account Overview page also lets customers link to their account seings.

account/prole Account Seings page—Allows customers to change their user name and enter contact information.

account/prole_picture Update Your Prole Picture page—Lets community users update their prole picture with a default
picture or the user’s Gravatar or Facebook prole picture.

account/reset_password Reset Your Password page—Contains a form where customers can reset their password. The page is
accessed only through an email link sent to their primary email address when they request account
assistance to reset their password. The link expires after a specied period of time (24 hours by
default). If customers do not have a complete contact record, they are taken to the Prole page when
they are nished on this page so they can nish seing up an account.

account/setup_password Finish Account Creation page—Displays a page with a link to the Account Assistance page. This page
is displayed when customers click an email link to reset their password and the link has already expired
or when a customer wants to create an account using an email address that is already in the knowledge
base.

account/notif/list Notications page—Displays all answers customers have subscribed to as well as product/category
notications they have subscribed to. The page allows customers to delete and renew notications and
add product/category notications.

account/notif/unsubscribe Your Notication Requests: Unsubscribe Results page—Displays a message to customers who have
clicked an email link to unsubscribe to an answer notication. This page can be accessed only through
the email link.

account/questions/detail Question Details page—Displays the details of a specic question submied by a customer and allows
the question to be updated. This page also contains a print buon.

account/questions/list Support History page—Displays all questions submied by a customer, including the subject, reference
number, status, and date created. Selecting an incident in the list opens the details of the customer’s
question.

agent/guided_assistant Guided Assistant page—Displays a guide on the guided assistance designer of the administration
interface as it will appear on the customer portal.

agent/polling_preview Polling Preview page—Displays a preview of the polling widget to the sta member creating a survey
to show how it will appear on the customer portal.

answers/detail Answer Details page—Displays details about a specic answer and includes options for sharing,
 printing, emailing, and subscribing to the answer. The default page also lets customers submit answer
feedback and view related and previously viewed answers.

answers/list Published Answers page—Displays a list of answers that meet the customer-entered search criteria.
The page contains a search eld with advanced search options.

ask Ask a Question page—Allows customers to submit a question.

ask_conrm Ask a Question Conrmation page—Conrms the submial of a customer’s question and displays the
reference number of the incident that was created.

basic/ask Basic Email Us page—Lets customers submit a question using their basic device.

basic/ask_conrm Basic Question Conrmation page—Conrms the submial of a customer’s question and displays the
reference number of the incident that was created.

basic/error Basic Error page—Displays one of several error messages, depending on the circumstances that
caused the error. The error_id parameter is passed in the error page URL.
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Page File Name Page Title and Description

basic/error404 Basic Error 404 page—Displays a Page Not Found error.

basic/home Basic Home page—The entry point for customers using basic devices to access the customer portal. It
includes the top popular answers and support categories.

basic/account/change_
password

Basic Change Password page—Lets customers change their password using a basic device.

basic/account/overview Basic Account Overview page—Provides an overview of account information, where customers can
view the questions they have submied. The Account Overview page also lets customers link to their
account seings and the Change Password page.

basic/account/prole Basic Account Seings page—Lets customers change their account information using a basic device.

basic/account/reset_password Basic Reset Password page—Contains a form where customers can reset their password. The page is
accessed only through an email link sent to their primary email address when they request account
assistance to reset their password. The link expires after a specied period of time (24 hours by
default). If customers do not have a complete contact record, they are taken to the Account Seings
page when they are nished on this page so they can nish seing up an account.

basic/account/setup_password Basic Finish Account Creation page—Displays a page with a link to the basic Account Assistance page.
This page is displayed when customers click an email link to reset their password and the link has
already expired or when a customer wants to create an account using an email address that is already
in the knowledge base.

basic/account/questions/detail Basic Question Details page—Displays the details of a specic question submied by a customer and
allows the question to be updated using a basic device.

basic/account/questions/list Basic Questions List page—Displays all questions submied by a customer, including the subject,
 reference number, status, and date created. Selecting an incident in the list opens the details of the
customer’s question.

basic/answers/detail Basic Answer Details page—Displays the details of an answer to customers using a basic device.

basic/answers/list Search Results page—Includes a multiline report that has been optimized for basic devices and
product and category search lters.

basic/answers/submit_
feedback

Submit Feedback page—Lets customers submit feedback regarding specic answers on the basic page
set.

basic/utils/account_assistance Basic Account Assistance page—Displays a page that lets customers using a basic device request an
email containing either their user name or a link to a page for reseing their password. If the customer
is logged in, the email address eld is populated.

basic/utils/create_account Basic Create Account page—Displays a page that lets customers using a basic device create an account
(which creates a contact record in the knowledge base) by entering their email address, user name,
 password, and rst and last names.

basic/utils/login_form Basic Login page—Displays the Login page where customers using a basic device can enter their user
name and password.

basic/utils/submit/password_
changed

Basic Password Change Conrmation page—Displays a message that a customer’s password change
was successful.

chat/chat_landing Chat page—When a customer is waiting for an agent, this page displays position in queue and
estimated and average wait times, along with a search eld. When an agent is available, the Chat
window opens.

chat/chat_launch Live Help page—Lets customers request customer support using Chat.
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Page File Name Page Title and Description

error404 Error 404 page—Displays a Page Not Found error.

error Error page—Displays one of several error messages, depending on the circumstances that caused the
error. The error_id parameter is passed in the error page URL.

home Support Home page—Serves as customers’ main entry into the customer portal.

mobile/ask Mobile Ask a Question page—Lets customers submit a question using their mobile device.

mobile/ask_conrm Mobile Ask Question Conrmation page—Conrms the submial of a customer’s question and
displays the reference number of the incident that was created.

mobile/error404 Mobile Error 404 page—Displays a Page Not Found error.

mobile/error Mobile Error page—Displays one of several error messages, depending on the circumstances that
caused the error. The error_id parameter is passed in the error page URL.

mobile/home Mobile Home page—The entry point for customers using mobile devices to access the customer
portal. It includes the top six most popular answers and the top-level support categories.

mobile/account/change_
password

Mobile Change Password page—Lets customers change their password using a mobile device.

mobile/account/prole Mobile Account Seings page—Lets customers change their account information using a mobile
device.

mobile/account/prole_picture Update Prole Picture page—Lets community users on a mobile device update their prole picture
with a default picture or the user’s Gravatar or Facebook prole picture.

mobile/account/reset_
password

Mobile Reset Password page—Contains a form where customers can reset their password. The page
is accessed only through an email link sent to their primary email address when they request account
assistance to reset their password. The link expires after a specied period of time (24 hours by
default). If customers do not have a complete contact record, they are taken to the mobile Account
Seings page when they are nished on this page so they can nish seing up an account.

mobile/account/setup_
password

Mobile Finish Account Creation page—Displays a page with a link to the mobile Account Assistance
page. This page is displayed when customers click an email link to reset their password and the link has
already expired or when a customer wants to create an account using an email address that is already
in the knowledge base.

mobile/account/questions/
detail

Mobile Question Details page—Displays the details of a specic question submied by a customer and
allows the question to be updated using a mobile device.

mobile/account/questions/list Mobile Support History page—Displays all questions submied by a customer, including the subject,
 reference number, status, and date created. Selecting an incident in the list opens the details of the
customer’s question.

mobile/answers/detail Mobile Answer Details page—Displays the details of an answer and allows customers to provide
answer feedback using a mobile device.

mobile/answers/list Mobile Answers List page—Includes a multiline report that has been optimized for mobile devices and
product and category search lters.

mobile/chat/chat_landing Mobile Chat page—Displays chat wait information and a transcript of the chat on a mobile device.

mobile/chat/chat_launch Mobile Chat Launch page—Lets customers request customer support using Chat on their mobile
device.

mobile/products/detail Mobile Product Details page—Displays the list of popular published answers and recent community
discussions related to the selected product or category on a mobile device.
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Page File Name Page Title and Description

mobile/social/ask Mobile Community Ask a Question page—Displays a page that lets customers submit a question to the
community while using a mobile device.

mobile/social/questions/detail Mobile Community Discussion Detail page—Displays a single discussion, including question and
comments, on a mobile device.

mobile/social/questions/list Mobile Community Results page—Displays a list of community discussions on a mobile device that
match the entered search term.

mobile/utils/account_
assistance

Mobile Account Assistance page—Displays a page that lets customers using a mobile device request
an email containing either their user name or a link to a page for reseing their password. If the
customer is logged in, the email address eld is populated.

mobile/utils/create_account Mobile Create Account page—Displays a page that lets customers using a mobile device create an
account (which creates a contact record in the knowledge base) by entering their email address, user
name, password, and rst and last names.

mobile/utils/guided_assistant Mobile Guided Assistant page—Opens the page containing a guide that asks customers using a mobile
device a series of questions designed to lead them to a solution specic to their situation.

mobile/utils/login_form Mobile Login page—Displays the Login page where customers using a mobile device can enter their
user name and password or click a buon to create an account.

mobile/utils/submit/password_
changed

Mobile Password Change Conrmation page—Displays a message that a customer’s password change
was successful.

mobile/utils/submit/prole_
updated

Mobile Prole Update Conrmation page—Displays a message that the customer’s prole was
successfully updated.

products/detail Products Detail page—Displays a list of published answers and community discussions related to a
specic product.

public_prole Public Prole page—Displays a list of a user’s recent community activity, including ratings, questions,
 and comments.

public_prole_update Update Public Prole page—Lets community users change their avatar (prole picture) and display
name.

results Search Results page—Displays the published answers and community discussions that match the
entered search term.

social/ask Community Ask a Question page—Lets customers submit a question to the community.

social/moderate/comment Comment Moderation Dashboard page—Lets moderators moderate discussions comments from a
report.

social/moderate/overview Moderation Overview page—Displays a summary for moderators that displays recent question,
 comment, and user activity.

social/moderate/question Question Moderation Dashboard page—Lets moderators moderate discussion questions from a
report.

social/moderate/user User Moderation Dashboard page—Lets moderators moderate community users from a report.

social/questions/detail Community Discussion Detail page—Displays a community question and all of its comments.

social/questions/list Results from the Community page—Displays community discussions that match the entered search
terms.
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Page File Name Page Title and Description

utils/account_assistance Account Assistance page—Lets customers request an email containing either their user name or a link
to a page for reseing their password. If the customer is logged in, the email address eld is populated.

utils/create_account Create an Account page—Lets customers create an account (which creates a contact record in the
knowledge base) by entering their email address, user name, password, and rst and last names.

utils/editing_help Advanced Editing Help page—Oers tips for editing content using plain text markdown.

utils/help_search General Search Tips page—Displays search tips to help customers understand the best way to conduct
a search. You can create a link to this page if you think your customers will nd it helpful.

utils/login_form Log In page—Displays a page where customers can enter their user name and password or click a
buon to create an account.

utils/submit/password_
changed

Password Change Succeeded page—Displays a message that a customer’s password change was
successful.

utils/submit/prole_updated Prole Update Succeeded page—Displays a message that the customer’s prole was successfully
updated.

Error 404 Page  
The CP_404_URL conguration seing has a default value of error404, which is the page that opens if customers try to
access a nonexistent page.

The Error 404 page content is loaded without modifying the URL, so any incorrect characters in the URL can be
replaced instead of requiring the entire URL to be re-entered. You can also add conditions, widgets, or other customer
portal elements to the page to help the customer.

If the value for CP_404_URL is blank, the browser’s generic error page opens instead.

Error Codes and Messages  
Depending on the parameter passed in the error page URL, various error messages are displayed to the customer.

Error Code Error Heading and Message

1 Not available—This answer is no longer available.

2 Not available—We’re sorry. Your account doesn’t have the service level agreement required to view this
document.

3 File Download Error—Sorry, there was an error downloading the le.

4 Permission Denied—You do not have permission to access this document.

5 Operation Failed—Submission Failed. The page could not be submied and the operation timed
out. Use the Back buon to return to the page. Then refresh the page so that you can resubmit the
information.
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Error Code Error Heading and Message

6 Permission Denied—An illegal parameter was received.

7 Cookies are required—You’ll need to enable cookies in your browser before you can continue.

8 Not available—There is nothing here for you, sorry!

9 Not available—This discussion is no longer available.

sso9 Incomplete Account Data—Sorry, to create an account within the community, you must specify an
email address. Please update your account.

sso10 Incomplete Account Data—Sorry, to create an account within the community, you must specify a rst
and last name. Please update your account.

sso11 Duplicate Email—Sorry, the email address you specied already exists within the community. You
might already have an account with that email address. Please visit the account assistance page for
further help.

sso13

sso14

sso15

sso16

sso17

Authentication Failed—The link you clicked contained an authentication parameter that failed to
authenticate. This might have happened because:
 

1. The link was intended for you, but has expired.
2. This authentication parameter has already been used by you.
3. The link you clicked was not intended for you, but was meant for another user and was given to

you erroneously.

404 Not found—Page not found.

Customer Portal Widgets  

Customer Portal Widgets  
A widget is an element of the Oracle Customer Portal Cloud Service (Customer Portal) that performs a specic function.

The Customer Portal contains more than one hundred widgets in its standard widget collection. Here are a few
examples of standard widget functionality.

• An information eld for input of customer information

• A buon that launches a search or submits customer information

• A report that returns all answers containing a customer’s search terms

• A dialog for customer feedback

• A topics tree for browsing specic topics

• A link to let customers share their desktop with an agent on the phone

• An oer to chat with an agent

You can congure the functionality of standard widgets by editing their aributes to achieve dierent results. A
standard widget on one page may function dierently than the same widget on a dierent page, depending on the
aribute seings.
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You can also create custom widgets by extending the functionality of a standard widget, or you can create custom
widgets from scratch.

By their nature, widgets are highly diverse elements, and we don't go into all the details of each one. For widget-specic
information, visit hps://<your_site>/ci/admin/docs/widgets/standard. You can select a folder and widget to see
its denition, preview, description, default code, aributes, and other conguration information.

Widget Accessibility  
The Customer Portal widgets have been designed to comply with Oracle Accessibility Guidelines.

When you create custom widgets, you are responsible for ensuring that your changes do not impact accessibility. Labels
require particular aention. Input labels support accessibility by providing content for screen readers, and they should
be used. However, if you choose to use an empty string for a label, some widgets will not include the asterisk that
indicates the input eld is required, even if you set the required aribute to true.

Related Topics
• Oracle’s Accessibility Program

Widget Files and Code  
A widget is a collection of les that work together to provide a specic functionality.

Widgets communicate with the Oracle database and the server through AJAX requests. They also communicate with
other widgets through events. When you add a widget to a page or a template, you add code resembling this example.

<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
validate_on_blur="true" initial_focus="true" label_input="#rn:msg:EMAIL_ADDR_LBL#"/>

The widget code contains these elements.

• rn:widget—Identies the object as a widget to be rendered on the page. The rn: prex identies the widget as a
standard Customer Portal element.

• path—Locates the widget in the le structure by specifying the folder and widget name.

• aributes—Denes widget parameters that control appearance and function.

Widget les are stored in widget group subfolders (/chat/, /discussion/, /feedback/, /input/, etc.) in the /cp/core/
widgets/standard folder. Each widget has its own subfolder containing all the les for that widget.

A widget may contain some or all of these les:

• info.yml—Provides information about a widget’s dependencies, requirements, aributes, and URL parameters.
Every widget has a YAML le.

• controller.php—Constructs the widget and calls the data it needs. The originating release is identied in the
rst line of code.

• view.php—Contains the HTML required to display the widget. The originating release is identied in the rst
line of code.

• *.html.php—Denes a view partial, which is a subset of the widget’s view and is called from the view.php le.
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• logic.js—Contains the display logic and events the widget subscribes to or res. This le also contains logic for
updating the widget’s HTML when new information is received from an event.

• *.ejs—Embedded JavaScript template les that combine variables and the template to produce HTML.

• base.css—Provides the non-editable CSS for a widget.

• presentation.css— Controls the stylistic elements that determine how the widget displays on a page. The
presentation CSS les are located in the /cp/core/assets/default/themes/standard/widgetCss or /cp/
core/assets/default/themes/mobile/widgetCss folder and include the widget name.

• preview/preview.png—Displays an example of what the widget will look like when it is added to a page.

Overview of the YAML File  
This topic uses the info.yml le for the KeywordText widget to describe the parts of an YAML le.

Every widget has an information le wrien in YAML format, which contains no executable code.

version: "1.1.1"
requires:
 framework: ["3.3"]
 jsModule: [standard, mobile]
 attributes:
 report_id:
 name: rn:msg:REPORT_LBL
 type: STRING
 description: rn:msg:ID_RPT_DISP_DATA_SEARCH_RESULTS_MSG
 default: rn:def:CP_NOV09_ANSWERS_DEFAULT
 source_id:
 name: rn:msg:SOURCE_ID_LBL
 type: STRING
 description: rn:msg:NAMED_SRC_WIDGET_FIRE_SRCH_EVENTS_LBL
 label_text:
 name: rn:msg:LABEL_LBL
 type: STRING
 description: rn:msg:STRING_LABEL_DISP_WARN_MODIFICATION_LBL
 default: rn:msg:SEARCH_BY_KEYWORD_CMD
 initial_focus:
 name: rn:msg:INITIAL_FOCUS_LBL
 type: BOOLEAN
 description: rn:msg:SET_TRUE_FIELD_FOCUSED_PAGE_LOADED_MSG
 label_placeholder:
 name: rn:msg:PLACEHOLDER_LABEL_LBL
 type: STRING
 description: rn:msg:PLACEHOLDER_NOTE_INPUT_SPACERS_SUPP_IE9_LBL
 default: rn:msg:ASK_A_QUESTION_ELLIPSIS_MSG
 info:
 category:
 - Report Search
 description: rn:msg:WIDGET_DISP_INPUT_TXTBOX_ALLOWS_MSG
 urlParameters:
 kw:
 name: rn:msg:KEYWORD_LBL
 description: rn:msg:SETS_TXT_KEYWORD_BOX_URL_PARAM_VAL_LBL
 example: kw/roam

This le includes these elements:

• version—Denes the widget’s version number. Custom widgets must have a major and minor version specied,
while standard widgets also include a nano version.
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• requires—Denes the required framework version number, the required JavaScript module, and any YUI
modules that need to be loaded for widget functionality. The Customer Portal Framework Version 3.3 uses
the YUI 3.17 library. Several standard YUI modules are available on every page, and any module is available to
widgets that declare dependency on that module.

• attributes—Denes the widget’s aributes and their values. Note that if a custom widget inherits aributes of
a standard widget when it is created, only the inherited aributes that have been removed or edited are listed in
info.yml. The others are implied because the custom widget was created by extending the standard widget.

• extends—Identies the standard widget that was used as the parent widget if this widget was created by
extending another.

• info—Provides a description of the widget’s functionality and an array of URL parameters the widget gets
information from, including name, description, an example, and whether the parameter is required. The
Widget Info page, accessed at hps://<your_site>/ci/admin/docs/widgets/info, is an additional source of
information about the info.yml le when you’re on the Customer Portal Administration site.

Overview of the Controller File  
The controller le renders and previews the widget.

The functions within the le construct the widget and get the data the widget needs. The get data function of
controller.php instantiates the widget.

The controller les of standard widgets have been intentionally wrien to omit the closing PHP tag (?>). Additionally,
code has been added to automatically remove the closing PHP tag from the end of widget controllers during the
staging operation. If you add a closing tag to a widget controller le, the widget will display and work properly on the
development site, but parsing errors might occur on the staging site.

Overview of the View File  
The view le contains blocks of code that indicate the elements of the code that you can edit.

In the view.php le, every block has a unique ID that describes its context. Although standard widgets don’t actually use
the block tags, the tags identify where you can edit the code. They serve as customization hook points where you can
add custom code to the standard widget to create a custom widget. Not every element of every widget is exposed as a
block if modifying the element would cause problems with the standard code.

Only the code within blocks can be edited. If you add code outside of block tags, your code will be ignored. If you don’t
specify the ID of a standard block or if the ID you specify doesn’t exist in the standard widget’s view, your code will also
be ignored.

When a standard widget undergoes a nano change, the change is automatically applied to the widget in your customer
portal les so that you can take advantage of the bug x or enhanced functionality. Additionally, any custom widgets
that were created by extending that standard widget will also be updated. This benet of automatic updating of custom
code is possible whenever you extend a standard widget’s view instead of overriding it when you create a custom
widget.

Related Topics
• Customer Portal Framework Versioning
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View Partials and the View File  
View partials are sections of code that can be used multiple places within a widget or shared across multiple widgets.

Many widget view.php les include duplicate sections of code that are used throughout the widget. Other widgets
share sections of code, and each widget calls out the same code section.

The cp/core/framework/views/Partials folder contains these view partial les that can minimize code duplication by
leing you reuse common view elements, such as the red asterisk and screen reader label to indicate a eld is required.

If a widget is within a view partial, the widget is rendered in the view.

Multiple View Partials  
Rather than a single large view le, some widgets have partial view les that are smaller subsets of the view.

The view.php is the main widget view, but it renders the partial view les, which also appear in the widget’s folder. For
example, the AnswerFeedback widget was split into three view partials. These view partials use the *.html.php naming
convention.

The view.php le for the AnswerFeedbackWidget contained 79 lines of code in Framework Version 3.2.1, while the same
le in Version 3.3.1 contains only 18 lines, including three lines that call the widget’s view partials to render the various
feedback options: Yes/No buons, up to ve stars, and a numerical ranking scale.

When you extend a standard widget and choose to extend its view, the extended widget contains the standard widget’s
view.php le and all of its view partial les. When you do not change the standard widget’s view (both View questions
are answered No) or when you override the view instead of extending it (by answering Yes to “Does this widget modify
the parent widget’s view?” and selecting the Override option), the standard widget’s view partials are not included in the
view of the extended widget.

The view partials within a single widget have all the functionality of regular views. They can reference other widgets with
the $this context, and they can use <rn:block> and #rn:# tags.

Multiple Widgets Sharing View Partials  
This topic uses the SiteFeedback widget to demonstrate how you can use view partials across multiple widgets.

Unlike view partials within a single widget, which have the same functionality as regular view les, view partials that are
shared among several widgets have limited functionality. They cannot render widgets or use rn: tags. Nor can they use
the $this context to access widget properties.

For example, the SiteFeedback widget contains this code.

<label for="rn_<?=$this->instanceID?>_FeedbackTextarea">
 <?= $this->data['attrs']['label_comment_box'] ?>
 <?= $this->render('Partials.Forms.RequiredLabel') ?>
</label>
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It calls the view partial RequiredLabel.html.php in the /cp/core/framework/views/Partials/Forms folder, which
contains this code:

<span class="rn_Required"><?= $requiredLabel ?:/RightNow/Utils/Config::getMessage(FIELD_REQUIRED_MARK_LBL) ?
></span>
<span class="rn_ScreenReaderOnly"> <?= $screenReaderLabel ?:/RightNow/Utils/
Config::getMessage(REQUIRED_LBL) ?></span>

Instead of duplicating the same HTML across dierent widgets to create the red asterisk and screen reader label to
indicate a required eld, this single shared view partial can be reused by any widget that needs it by simply calling:

$this->render('Partials.Forms.RequiredLabel')

If you want to override contents of a standard view partial, you must register a custom view in /cp/customer/
development/cong/extensions.yml by adding this text to the le.

partialViewExtensions: - Partials.Forms.RequiredLabel

Then whenever the Required.Label view partial is called, the custom le located in /cp/customer/development/
views/Partials will be used instead of the standard one in the core folder.

Custom View Partials  
A custom view partial lets you set dierent functionality in standard view partials.

For example, if you want to use two blue asterisks instead of a single red one to indicate a required eld, you can create
a custom view partial le with the same name as the standard.

Using the RequiredLabel view partial as an example, you would create the new view le, name it
RequiredLabel.html.php, and place it in /cp/customer/development/views/Partials/.

After creating the custom view and placing it in the /cp/customer/development/views/Partials folder, you must
register the view. You do that by adding this text to the /cp/customer/development/cong/extensions.yml le.

viewPartialExtensions:
 - Partials.Forms.RequiredLabel

Now, calling the RequiredLabel view partial will call the custom view from your development site instead of the standard
view partial.

To create a new view partial that can be shared among widgets, create the le and add it to /cp/customer/
development/views/Partials. If your new le is named mySharedPartial.html.php, for example, you would add this
code to the custom widget’s view.php le.

<?=$this->render('Partials.MySharedPartial') ?>

Because you are not overriding a standard view partial, you do not have to register your custom view partials in the
extensions.yml le as you do when you want to replace a standard view partial.

Overview of the Logic File  
The logic le contains the display logic and events for the widget.
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The widget may subscribe to or re custom events to and from the event controller. This le also calls any JavaScript
templates the widget might use. The logic.js le is optional.

Overview of Widget CSS Files  
Some widgets have a base CSS le, others have a presentation CSS le, and many standard widgets have both.

The base CSS le for a widget controls its functionality, while the presentation CSS controls the appearance of a widget.
By having separate presentation les, you can control the appearance of one widget without impacting the appearance
of any other widgets.

• Base: controls widget functions (/cp/customer/development/widgets/custom/[customWidget]/base.css)

◦ should contain rules that structure the widget or make it function correctly, with very few or no styling
rules in the le

◦ should not include generic functionality rules

◦ rules should start with the class name in the top-level <div> element in the view

◦ can be omied

• Presentation: controls the appearance of a widget (/cp/customer/assets/themes/standard/widgetCss/
[widgetName.css])

◦ must have the same name as the widget

◦ rules should start with the class name in the top-level <div> element in the view

◦ should contain no generic styling rules

You cannot edit the base CSS les for standard widgets, which are stored in the folders with the other les that make up
each widget.

Widgets that have a corresponding CSS le in the /cp/customer/assets/themes/standard/widgetCss folder
use that CSS le to control the presentation, or appearance, of the widget when it is rendered on a page. This le
contains the rules for adding stylistic elements to the widget. The le name is [WidgetName].css, for example,
AdvancedSearchDialog.css. The changes you make to presentation CSS les are sandboxed in the /themes/ folder, so
you can view them on your development site, but you must stage and promote the customer portal before you can see
those changes on your production site.

All widget styling must exist in one of the CSS les. Widget code cannot contain any inline CSS rules.

Best practices for widget CSS les include using as few classes as possible, using the top-level widget CSS class aribute
to style elements within the widget, and creating styling rules only if a site CSS rule must be overridden.

Standard and Custom Widget Folders  
All standard and custom widgets that are part of the Customer Portal reference implementation are stored together.

All of the standard widgets are stored in the /cp/core/widgets/standard folder, and all custom widgets that you
create should be stored in the /cp/customer/development/widgets/custom folder.
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The page code of the standard reference implementation les denes widgets without specifying whether they are in
the standard or custom folder. Because the reference implementation uses only standard widgets, they are all stored in
the standard folder.

When you modify page code to add or edit a widget, you do not have to specify a folder for the widget path. If you
explicitly indicate either the standard or custom widget folder, the code will call the widget from that folder. If you do
not specify a folder, the custom widget folder is searched rst. If no widget with that name exists in the custom folder,
the standard folder is searched.

Because the custom folder is searched before the standard folder, you can replace a standard widget with a custom
one that uses the same name without having to nd and replace all calls to the new widget in all customer portal
pages. When you give a custom widget the same name as a standard widget, the custom path must be the same as
the standard path. For example, if you create a custom AdvancedSearchDialog widget, you must create a subfolder
called sear ch under the custom widget folder and place the widget in that subfolder so the relative path for the custom
widget is the same as that of the standard widget. In other words, the path for the standard widget is standard/search/
AdvancedSearchDialog. Therefore, the path for the custom widget must be custom/search/AdvancedSearchDialog.

Overview of Widget Controllers  
A deployment failure will occur if two dierent widgets on the same page use the same widget folder name.

When two dierent widgets on the same page use the same widget folder name and cause a deployment failure, the
widgets have the same class name in the controller. If you copy a widget and use the same widget name for the custom
widget.

For example, you create a custom input widget, name it FormInput, and put it in the widgets/custom/input folder, the
custom widget uses the custom controller. However, because it has the same name as the standard widget’s controller,
a failure occurs if both widgets are placed on the same page. The error message lists the two widgets using dierent
controllers that have the same class name and identies the page where they are found. This lets you correct the
problem by copying the view.php les of the custom widget to the appropriate folders.

Widget AJAX Requests  
When widgets require data, they make an AJAX request to the server.

You dene where a widget’s request goes by seing a value for a specically named AJAX endpoint aribute. For
example, the ConditionalChatLink widget has an aribute called get_chat_info_ajax that lets you dene where the
request for chat availability will be sent. The default value is /ci/ajax_Request/getChatQueueAndInformation. All
requests are sent to /ci/ajaxRequest/, which loads the ajaxRequest controller so it can execute the specied function,
which is getChatQueueAndInformation in this example.

Overview of YUI Usage  
The Customer Portal uses YUI 3.17.
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While the Customer Portal uses YUI 3.17, you can substitute the value {YUI} at the beginning of a le name to use the
most current YUI version. These default YUI modules are included on each page, so you don’t need to call them out
specically in the widget code.

• anim-base

• anim-easing

• escape

• event-base

• history

• node-core

• node-event-delegate

• node-screen

• node-style

You can also use these YUI requirements in jsModule.

• yui: [panel, autocomplete, autocomplete-highlighters]

• yui: standard: [overlay]

How You Find Widgets  
There are a variety of ways to browse and search for customer portal widgets.

You can open the Widgets page of the Customer Portal Administration site by entering hp://<your_site>/ci/admin/
docs/widgets. You must log in with your user name and password, so make sure your prole includes the CP Edit
permission.

You can also access this page from anywhere on the Customer Portal Administration site (hp://<your_site>/ci/
admin) by clicking the Widgets tab.

You can quickly navigate among the dierent widget folders. After you click Browse Widgets, select Standard Widgets,
and select a folder, you can click the drop-down menu associated with the folder level and select a dierent folder.

Or, if you know the widget’s name, you can enter the rst few leers or any part of the name in the Search Widgets eld
to display a menu of widgets that match your entry.

Display Widget Versions  
Widget versions are displayed in the widget information found on the administration site.

Every customer portal widget has a version number, leing you incorporate only that widget without requiring you to
use an entire widget set or a new framework version.

1. Log into your Customer Portal Administration site.
2. Click Widgets.
3. Select Widget Versions.
4. To lter the list of widgets, click View Options.
5. To display standard widgets only, select  View Options > Widgets > Standard .
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6. To display custom widgets only, select  View Options > Widgets > Custom .
7. To lter the list of widgets by widget status, click View Options and select one of the widget status lters.

◦ To display all widgets that are currently activated on your customer portal, select Active.

◦ To display all widgets that have been deactivated, select Inactive.

◦ To select all widgets being used in their most current version, select Up To Date.

◦ To select all widgets for which newer versions are available, select Out Of Date.

8. To search for widgets in a specic category, click View Options and select a category.
9. To search for a specic widget, enter the rst few leers of the widget name in the Search eld.

10. To update all widgets to their most recent version for the Customer Portal framework being used by your site,
click Update All.

11. To see all recent version changes, click Recent Changes.

If you migrate versions for multiple widgets on your development site and then decide to stage and promote your
customer portal, you are required to deploy every migrated widget during the process. In other words, you cannot
selectively deploy widget versions during the staging and promoting processes.

Additionally, if you migrate a widget when a newer version is available because you want to use it on a page, the new
version will be used for every instance of that widget on your customer portal.

Select a Widget  
Widget information is dened in detail when you select the widget on the Customer Portal Administration site.

1. Enter https://<your_site>/ci/admin to log in to the Customer Portal Administration site.
2. Click Widgets.
3. Select the widget.

◦ Select Browse Widgets, select Standard Widgets or Custom Widgets, select the widget folder, and then
select the widget name.

◦ Select Widget Versions and select the widget you want to open from the list.

◦ Enter the widget name in the Search Widgets eld.

Three tabs appear on the widget information page: Available Versions, Widget Usage, and Recent Version Changes.
These elements appear on the page regardless of the selected tab.

• Preview—The preview shows you an example of what the widget looks like on a page. If the widget is larger
than the preview window and the display provides only a partial view, you can click the preview window to
display an expanded view of the widget.

• Widget history timeline—A timeline at the top of the page shows the available versions of the widget and the
version currently in use. If the widget version is 1.0, the message says, “This is the newest version.”

Overview of Available Versions Tab  
There are a number of aributes on the Available Versions tab of the Widget Information page.

These elements appear on the Available Versions tab.

• Staging/Production/Development—When multiple versions of the widget exist, the areas using each version
are noted.
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• Framework requirements (dependency information)—The page includes the framework version that must be
installed to support the widget version.

• Widget version information—Each version of the widget is listed on the page, with the newest listed rst. The
version section describes the changes that were made from the previous version. The changes are categorized
as likely impact, possible impact, or no impact to custom code, determined by hovering over the bullet for each
change. Changes are also classied as new features, removal of functionality, API changes that impact the
widget, or bug xes.

• Documentation—Clicking Documentation opens a page of information specic to the widget, including
description, default code, aributes by category (such as labels, image paths, and AJAX endpoints), the
controller class, path information, and URL parameters. (If the page describes a custom widget that was
extended from another widget, it will also list the parent widget.)

• Dependencies—When a standard or custom widget has dependencies, the Dependencies buon appears on
the widget information page next to the Documentation buon. Clicking the Dependencies buon opens a
window that displays the dependencies to other widgets.

◦ A widget contains other widgets (for example, AdvancedSearchDialog contains KeywordText and other
widgets)

◦ A widget is extended from another widget (for example, ChatAachFileBuon extends from
FileAachmentUpload)

◦ A widget is the parent of a widget (FileAachmentUpload is the parent of ChatAachFileBuon)

• Deactivate this widget—When you click this buon, the widget is no longer available for use on your site. Then,
when you lter on only the Active widgets, your list displays only the activated widgets. (Even deactivated
widgets will appear in the list of widgets if you do not select the Active lter.) For example, if you do not use
Oracle RightNow Chat Cloud Service (Chat), you may want to deactivate each of the chat widgets. When
you click the buon for a widget that is currently in use on your site, you are asked to verify that you want to
deactivate the widget and oered a chance to see where it is being used. (Even though you are not using Chat,
the reference implementation includes Chat pages that use the chat widgets so you will see the message.)

Widgets are not actually removed from the code when you deactivate them, but they are made unavailable for
use. After you have deactivated a widget, it does not appear in the list of widgets when you use the Active lter.
It does appear in the list when no lter is used, but it is grayed out to indicate that it is deactivated. If you click
a deactivated widget, you can reactivate it. An Activate This Version buon appears, and you can select the
version you want from the drop-down menu.

After selecting the version and clicking the buon, the widget is activated once again.

Note:  When new widgets are added in future releases, they are not automatically activated. You’ll
need to specify which version of the widget you want when you start using it. This prevents the
possibility of using a widget that was activated earlier but hadn’t been used yet if a newer version
becomes available before you decide to use it on your customer portal.

• Delete this widget—This buon appears only for custom widgets. When you click the buon, a conrmation
message appears. If the widget is being used on your customer portal, a Display Containing Views buon
appears on the conrmation message. Click the buon to display a list of pages and/or widgets that use the
widget you want to delete.

When you click Delete in the conrmation message, the widget is deactivated and deleted from the panel that
contains a list of all the widgets. All of the widget’s associated les are also deleted from the le structure, so
they no longer appear in the WebDAV le structure. The deleted les are listed in the message that tells you the
widget was deleted. You cannot reactivate the widget after deleting it.
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Overview of the Widget Usage Tab  
Selecting the Widget Usage tab displays the widgets, pages, and templates that use the widget.

Click the link to view the code snippet on the selected widget or page where the widget is used. Select a widget or page
from the list to view the snippet of page code where the widget appears, highlighted for easy location.

Overview of Recent Version Changes Tab  
The Recent Version Changes tab displays a list of recent updates to the widget.

Information includes whether a dierent version is now being used or if the widget was activated or deactivated. It also
includes the sta member who made the change and the date and time the change occurred.

Widget Aributes  
Each widget has properties that are specic to the instance of the widget.

A widget can look or behave one way on one page and dierently on another. You might even have two instances of the
same widget on one page with dierent aributes. For example, you could add a second ProductCategoryList widget to
the Support Home page to display a list of featured support products in addition to the featured support categories list
that appears on the page by default.

When a widget contains other widgets, you can use the aributes of the contained widgets in the widget denition.
For example, the DataDisplay widget contains, among other widgets, the FileListDisplay widget. The code for the
DataDisplay widget can include aributes of the FileListDisplay widget, even if those aributes are not available on the
DataDisplay widget. The aribute value specied in the DataDisplay widget code is passed on to the FileListDisplay
widget.

Additionally, you can create an RN Container page tag to dene a set of aributes and their values that are common to
multiple widgets. Then, instead of having to add every aribute to the code for each of the aected widgets, you can
use the container to dene the aributes.

If the widget code species an aribute that is also dened in the container, the value for the aribute in the widget
code overrides its value in the container.

The page for each widget on the administration site lists and explains the aributes of the widget and tells you how to
dene the aribute in the widget’s code.

Subwidgets and Aributes  
Several Customer Portal widgets contain other widgets.

Often a widget that is contained in a parent widget has aributes with the same name as the aributes of
another contained widget. The AdvancedSearchDialog widget, for example, contains two instances of the
ProductCategorySearchFilter, one for products and one for categories. Because you want to be able to specify unique
labels for each, both instances of the ProductCategorySearchFilter widget have their own ID value to let you use
the widget’s sub_id aribute to accomplish this. Review the Containing Widgets section of the documentation page
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for the AdvancedSearchDialog widget at hps://<your_site>/ci/admin/versions/manage/#widget=standard
%2Fsearch%2FAdvancedSearchDialog&docs=true&version=1.1. Notice that each of the widgets that are part of the
AdvancedSearchDialog widget now contains a sub_id aribute.

Seing a subwidget’s aribute requires the format:

sub:{sub_id}:{widget_attribute}="Value being set"

For example, this procedure uses this syntax to set the label_input aribute for the Product eld:

sub:prod:label_input="Your Product"

Congure a Widget With a Subwidget  
This example uses the AdvancedSearchDialog widget to demonstrate conguring a widget with a subwidget.

1. Open the page containing the AdvancedSearchDialog widget.
2. Locate <rn:widget path="search/AdvancedSearchDialog" report_page_url="/app/answers/list"/>.
3. Edit the code to include the subwidget labels.

<rn:widget path="search/AdvancedSearchDialog" report_page_url="/app/answers/list"
 sub:prod:label_input="Your Product" sub:cat:label_input="Your Category" />

4. Save the le.

Overview of the FormInput Widget  
The CustomAllInput widget contains the FormInput widget. The FormInput widget contains the SelectionInput,
DateInput, PasswordInput, DisplayNameInput, and TextInput widgets.

Because there are dierent types of input widgets in FormInput, each subwidget has its own ID, which you can use to set
aributes for all subwidgets of that particular type, similar to the example shown here.

<rn:widget path="input/CustomAllInput" hint="hint for every field except date fields"
sub:date:hint="hint for all date fields"/>

If the code sets an aribute based on type (text, selection, date) and that aribute is set to a specic value by default,
you can explicitly override the aribute using the subwidget code format:

sub:<id>:<attribute_name>="attribute_value"

This ensures that the value you specify takes precedence over aributes set in the widget’s view. For example:

<rn:widget path="input/CustomAllInput" table="Incident" sub:text:required="true"
sub:input_Incident.CustomFields.c.text1:text:required="false" sub:selection:hint="Hint for selection field"
sub:input_Incident.CustomFields.c.priority:selection:hint="Hint for Priority field" />

Notice that you must include the type after the eld name only if the code also has an aribute with
sub:type:<aribute_name>. That is, you can set specic aributes such as the required or hint value for a specic eld
using the format below.

<rn:widget path="input/CustomAllInput" table="Incident"
 sub:input_Incident.CustomFields.c.text1:required="true"
sub:input_Incident.CustomFields.c.priority:hint="Hint for Priority field" />

ChannelAllDisplay and ChannelAllInput Widgets  
This example uses subwidgets to dene custom labels.

The ChannelAllDisplay and ChannelAllInput widgets work similarly, where you can use subwidgets to dene custom
labels for each channel.

<rn:widget path="output/ChannelAllDisplay" sub:display_FACEBOOK:label="Custom Facebook username"

1147



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

 sub:display_TWITTER:label="Custom Twitter username" 
 sub:display_YOUTUBE:label="Custom YouTube username" /> 
<rn:widget path="input/ChannelAllInput" 
 sub:input_FACEBOOK:label_input="Custom Facebook input field"
 sub:input_TWITTER:label_input="Custom Twitter username"
 sub:input_YOUTUBE:label_input="Custom YouTube input field" />

Editing Widget Labels  
This example uses the RecentlyAnsweredQuestions widget to demonstrate changing widget labels.

1. Open /views/pages/home.php.
2. Locate <rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"/

>.
3. Navigate to the widget’s Documentation page and determine the aribute names for the labels you want to

edit.
4. Edit the code to add the label aributes you want to change.

<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true"
maximum_questions="5" label_answer_more_link="Expand Discussion"
label_moderator_answer="Staff Best Answer" label_user_answer="Original Poster Best Answer"/>

5. Save the le.

How You Change Reports in Widgets  
You can edit the widgets on a page to change the reports used by that page.

When a page includes search navigation with an answers report, multiple widgets are used to control the functionality.
For example, the Published Answers page includes these widgets:

• Elements of the search tool:

◦ Search eld (KeywordText widget)

◦ Search buon (SearchBuon widget)

◦ Search lters (ProductCategorySearchFilter widgets)

• Elements of the returned search results:

◦ The report itself (Multiline widget)

◦ The display of total number of results (ResultInfo widget)

◦ Pagination control (Paginator widget)

Six widgets on the Published Answers page make up the search eld and report, and each of these widgets must call
the same report in order for the page to display meaningful information. The reference implementation uses a container
page tag to dene this report ID as 176, which is the Answers–Complex Expression Search Default report.

The same thing is true for any other Customer Portal page that uses the combination of search eld and report, whether
it is a page of the reference implementation or a custom page that you’ve created. All widgets that make up these
elements must call the same report using one of these methods.

• Use the RN Container page tag to identify one or more common aribute values and then embed a group of
widgets within the container tags or specify the container as a widget aribute.

• Edit every search and report widget on the page by adding the report_id aribute to the widget code and
seing its value to the ID of the report you want to use. This is the aribute format: report_id="194"
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The hide_when_no_results Aribute  
The hide_when_no_results aribute prevents a widget from displaying if no search results match the entered terms.

The widgets that include the hide_when_no_results aribute are Multiline, Grid, MobileMultiline, and ModerationGrid.

To hide the widget, simply add the aribute and set its value to true. Here’s an example of adding the aribute to the
Multiline widget.

<rn:widget path="reports/Multiline" hide_when_no_results="true"/>

How You Dene the Number of Search Results  
You can dene the number of displayed search results.

The per_page aribute controls how many results are shown on a page. This code limits them to 5.

<rn:widget path="reports/Multiline" per_page="5" />

If the report denition on the Service Console includes row limits and the report widget denes the per_page aribute,
the widget aribute overrides the report denition.

How You Build Widgets  
You can create a new widget using the Customer Portal widget builder.

You can create custom widgets to suit your own business needs. Each custom widget can be designed from scratch as
a standalone widget, or it can inherit and extend the functionality and aributes of another widget (referred to as the
parent widget).

Note:  You can also create code for a custom widget and add it to your customer portal through WebDAV
without using the widget builder. The widget will appear in the list on the Widget Versions page, but you must
manually activate it by selecting it and then clicking Activate This Version in the upper right section of the
page.

The widget builder generates custom widget code based on your answers to a series of questions about the widget
you want to create. The generated code includes placeholders for additional code you’ll add to dene the new custom
widget. This reduces the amount of code you must write and minimizes the possibility of errors.

When you create a new widget by extending the functionality of an existing standard or custom widget, you can
dene whether the new widget will have its own controller, view, CSS, and JavaScript les or whether it will extend the
corresponding le from the existing widget that the new widget is being extended from.

To dene the behavior of a custom widget, you can include or modify aributes for these components.

• Controller—Initializes and processes data required for widget output. Controllers can also contain AJAX-
handling functions.

• View—Displays the PHP output generated by a controller, rendered as HTML. The le contains a top level div to
simplify your coding work.

• CSS—Denes the style and appearance of the view.

• JavaScript—Produces specic behavior and renders dynamic HTML views.

• YUI—Denes the YUI modules to be used with the new widget.
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• Additional widget details—Lets you add a widget denition, specify inherited URL parameters, and dene
JavaScript framework compatibility.

Considerations for Extending or Overriding the View  
You can extend or override a view from the parent widget when modifying a new widget.

If you indicate that the new widget will modify the view of the parent widget, you’ll be asked if you want to extend the
view or override it. This is an important question, and you should think carefully before selecting the override option.

We highly recommend that you choose to extend the widget view instead of overriding it. When you extend a standard
widget view, any future changes to the standard widget will be automatically applied to the custom widget that was
created by extending it. If you choose to override the view instead of extending it, your custom code will not be updated.

Note:  You can extend widget views past the child level. For example, if you extend the view for widget A to
create the view for custom widget B, you can also extend the view of widget B to create the view for widget
C. The parent view can be extended in the child view, which can be extended for the grandchild, and then the
great-grandchild.

Create a Widget  
You can create custom widgets to control many features on your customer portal.

1. Enter https://<your_site>/ci/admin to log in to the Customer Portal Administration site.
2. Click Create a New Widget.
3. Click Create a Brand New Widget From Scratch.
4. Enter the name (without spaces) of the custom widget in the What Is Its Name eld.
5. Enter the name of the custom widget’s parent folder in the And Its Parent Folder eld.
6. Click Continue.
7. Answer the widget components questions.

Question Description

Does this widget have a controller? Select Yes if you will create a controller le for the widget.

Will it be doing any AJAX-handling? Select Yes if the widget’s controller will handle AJAX requests.

Does this widget have a view? Select Yes if the widget will display HTML from the controller le’s PHP.

Does this widget have JavaScript? Select Yes if the widget will contain JavaScript. This option is automatically enabled
when the AJAX-handling option is enabled.

YUI Modules Click Add Module and begin typing the name of the YUI module you want to have
loaded on the page containing the widget and passed to the widget’s constructor. A list
of modules that match the text you enter appears so you can select the one you want.
To add more YUI modules, click Add Module and type the name. By default, several YUI
modules are already included on each page.
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Question Description

JavaScript templates too? Select Yes if the widget will display dynamic HTML content rendered by JavaScript.

8. Click Continue.
9. If you answered Yes to the question about AJAX handling, you can dene the default_ajax_endpoint aribute

by editing the name, selecting AJAX for the type, creating a description, seing a default value, and dening
whether the aribute is required.

10. To add another aribute, click Add an Aribute and enter eld information:

Aribute Description

Aribute name Enter the name of the aribute in the header eld.

Type Select the type of aribute you want to dene. Available types include string, Boolean,
AJAX endpoint, option, multi-option, le path, and integer.

Description Enter a description for the aribute. This text describes the aribute when you click
Documentation on the custom widget page.

Options Click Add Option and enter an option value to add one or more values to an option-
type aribute. This eld is available only when the aribute Type is set to Option or
Multi-option.

Default value Enter a default value for the aribute. By default, a Boolean-type aribute is set to true.
Select the False check box if you want the value to default to false.

This aribute is required Select this check box to make the aribute required.

11. To add more aributes, repeat step 10.
12. Click Continue.
13. To add details to the widget, click Add Additional Details and enter eld information.

Field Description

Widget description Enter a description for the widget that appears in the info.yml le and on the widget’s
denition page.

URL Parameters To add a URL parameter, click Add a URL Parameter and complete the Name,
 Description, and Example elds. (The Name eld cannot contain spaces or forward or
backward slashes.) To remove a parameter you added, click X.

Compatibility If you want the widget to work with a specic Customer Portal JavaScript framework,
 select Standard or Mobile or both. Or select No Framework JavaScript is Required.
This section does not appear if the widget does not have a JavaScript component.

14. Click Create Widget.
15. Edit the les that were generated so that the custom widget looks and performs as you intend it to.

To use the new widget in the staging environment, you must select Copy to Staging in the rst step and push the widget
version change in the second step of Stage Customer Portal Pages.
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Create a Widget by Extending the Functionality of a Widget  
You can use an existing widget to create a new custom widget.

1. Enter https://<your_site>/ci/admin to log in to the Customer Portal Administration site.
2. Click Create a New Widget.
3. Click Extend the Functionality of an Existing Widget.
4. Enter the name of the widget you want to extend in the Which Widget Shall It Extend From eld.
5. Select the widget you want to extend.
6. Enter the name (without spaces) of your new custom widget in the What Is Its Name eld.
7. Enter the name of the custom widget’s parent folder in the And Its Parent Folder eld.
8. Click Continue.
9. To enable specic widget components, select Yes for each correlating question.

Question Description

Does this widget have a controller of
its own?

Select Yes if you will create a controller le for the widget.

Will it be doing any of its own AJAX-
handling?

Select Yes if the widget’s controller will handle AJAX requests.

Does this widget modify the parent
widget’s view?

Select Yes if the widget will modify or override blocks of content within the view of its
parent.

Extend the view This is the recommended option. By extending the view of a standard widget, the
custom widget you create will be automatically updated when nano changes are made
to the standard widget in the future. No eort will be required on your part to consume
the new functionality or bug x.

Override the view This option means that you will be required to manually update the custom widget to
take advantage of any future changes to the parent widget

Include the parent widget’s CSS? Select Yes if the widget will include the CSS style aributes dened for its parent.

Does this widget have its own
JavaScript?

Select Yes if the widget will extend the JavaScript functions dened for its parent.

YUI Modules The Add Module link is active if you enable JavaScript functions. By default, several YUI
modules are already included on each page.

JavaScript templates too? Select Yes if the widget will modify blocks of content within the parent’s JavaScript view.

10. Click Continue.
11. To edit an inherited aribute, modify the aribute type, description, default value, or whether it is required.
12. To remove an inherited aribute, click the X.
13. To add an aribute, click Add an Aribute and enter the following eld information:
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Aribute Description

Aribute name Enter the name of the aribute in the header eld.

Type Select the type of aribute you want to dene. Available types include string, Boolean,
AJAX endpoint, option, multi-option, le path, and integer.

Description Enter a description for the aribute. This text describes the aribute when you click
Documentation on the custom widget page.

Options Click Add Option and enter an option value to add one or more values to an option-type
aribute. This eld is available only when the aribute Type is set to Option.

Default value Enter a default value for the aribute. By default, a Boolean-type aribute is set to true.
Select the False check box if you want the value to default to false.

This aribute is required Select this check box to make the aribute required.

14. To add another aribute, repeat step 13.
15. Click Continue.
16. To add details to the widget, click Add Additional Details and enter eld information.

Field Description

Widget description Enter a description for the widget that appears in the info.yml le and on the widget’s
denition page.

URL Parameters If the parent widget contains URL parameters, they will be listed in this section as
inherited parameters for the new widget.

Compatibility If you want the widget to work with a specic Customer Portal JavaScript framework,
 select Standard or Mobile or both. Or select No Framework JavaScript is Required. This
section does not appear if the widget does not have a JavaScript component.

17. Click Create Widget.
18. If necessary, edit the generated les.

Widget Builder Files  
The Widget Builder generates a number of les.

Each le in the custom widgets folder is used to enable certain functionality within the widget and can vary based on
whether the widget is a standalone widget or if it extends the functionality of another widget.

When you create a custom widget using the widget builder, some or all of these les are stored in the parent folder that
you dened in the /widgets/custom folder.
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File Description

info.yml Contains information about the widget, including its version and aribute values. If the widget extends
the functionality of another widget, this le also contains the name of that widget and any components
that are extended.

controller.php Initializes and processes the data required for the widget output. This le can also contain AJAX-
handling functions or modify AJAX functionality inherited from the parent, if any exists.

view.php Receives the PHP output generated by the controller and renders it as HTML. If the widget extends the
functionality of another widget, this le modies or overrides blocks of content within the view of the
parent.

logic.js Denes JavaScript functions used by the widget to produce dynamic behavior.

view.ejs Denes JavaScript functions used by the widget to render dynamic views.

<widget_name>.css Denes the style and appearance of the view.

base.css Contains any style information that extends the CSS of the parent widget, if applicable.

Preview a Custom Widget  
This procedure demonstrates including a screen capture of a custom widget in the widget denition.

1. Add a new subfolder called CustomWidget/preview to the /cp/customer/development/widget/custom
folder, where CustomWidget is the name of the widget you want to add a preview for.

2. Add a .png, .jpg, .jpeg, or .gif le to the subfolder you created and name it preview.
When you select the widget on your ci/admin/versions/manage page, the associated preview le render.

Input and Output Widgets  
Input widgets let customers enter information and output widgets let you display database content.

When you place input widgets on a page, your customers can enter and update information that gets stored in incidents
and contact records. Output widgets are used to display information about incidents, contacts, and answers in read-only
form.

You can help your customers enter the information you request by dening eld lengths, adding hints to input widgets,
and displaying the format that should be used. This section also denes how to input and output custom elds,
discusses using widget aributes, URLs, and POST parameters to dene default values, and describes a page tag that
can also be used for outpuing eld values.

The elds you can use for input and output widgets and the Field page tag are listed on the Business Objects page
of the Customer Portal Administration site. The page lists the names for the answer, asset, contact, incident, service
product, service category, social question, social question comment, and social user elds as they are dened in the
Connect PHP API.
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Widget Data Field Code Sample

FormInput Incident.Subject <rn:widget path="input/FormInput"
name="Incident.Subject" required="true" />

DataDisplay Answer.Products <rn:widget path="output/DataDisplay"
name="Answer.Products" />

Field page tag Contact <rn:field name="Contact.LookupName"/>

You will see an error in development mode if your code for an input widget includes a primary sub-object,
that is, if you try to use an input widget on a primary object that is the child of another object. For example,
this code will display an error message in the development area: <rn:widget path="input/FormInput"
name="Incident.PrimaryContact.Name.First" />

The exceptions to this limitation include Incident.Product, Incident.Category, and Contact.Address.Country.

When you create a custom object with custom menu aributes, the aributes can be used with FormInput and
DataDisplay widgets and the rn:field tags for Contact and Incident objects. Custom menu aributes can be used with
the DataDisplay widgets for Answer objects. All custom menu aributes appear on the Business Objects page of the
Customer Portal Administration site.

Input Widgets  
Input widgets allow customers to enter information.

These widgets are used to enter information for contacts or incidents.

• ChannelAllInput—Adds Twier, YouTube, and Facebook elds where customers can enter their user names for
those channels.

Note:  You can also dene input elds for single channels. Enter <rn:widget path="input/
FormInput" name="Contact.ChannelUsernames.TWITTER.Username" /> to add the Twier channel.
Change the name aribute to Contact.ChannelUsernames.YOUTUBE.Username for YouTube and
Contact.ChannelUsernames.FACEBOOK.Username for Facebook.

• ContactNameInput—Adds First Name and Last Name elds.

• CustomAllInput—Displays all contact custom elds on customer entry forms. You must specify the data table
(Contact or Incident) for the custom elds you want to display. You can also add individual custom elds by
deleting this widget and adding only the ones you want using the FormInput widget.

• DateInput—Displays a date drop-down menu where customers can enter date information you have requested.

• DisplayNameInput—Displays a eld for community users to enter their display name.

• EmailCheck—Validates a customer’s entered email address against the database and redirects them to the
Create an Account page if the entered address is not in the database.

• FileAachmentUpload—Displays a eld and Browse buon where customers can enter or select les to aach
to an incident.

• FormInput—Displays a eld that can be used to input system elds listed under Business Objects on the
Customer Portal Administration site. You must add the name aribute to this widget.

Note:  The exceptions are Incident.FileAachments, which is input with the FileAachmentUpload
widget, and Incident.Category and Incident.Product, which are input with the ProductCategoryInput
widget.
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• FormSubmit—Generates the buon on an input form that submits customer entries. On the reference
implementation, labels for this buon include Submit, Continue, Save Changes, and Create Account.

• PasswordInput—Lets customers set a new password.

• ProductCatalogInput—Displays product menus for customer selection on assets.

• ProductCategoryInput—Displays product and category menus for customer selection on the ask a question
pages.

• RichTextInput—Displays a text eld that allows HTML formaing tags.

• SelectionInput—Functions like the FormInput widget for menu and yes/no elds.

• SmartAssistantDialog—Displays a list of suggested answers and includes the Finish Submiing Question
buon for customers to submit the question they entered on the Ask a Question page.

• SocialUserAvatar—Lets community users select an avatar to associate with their display name.

• TextInput—Functions like the FormInput widget for text, text area, and integer elds.

Output Widgets  
There are widgets to display information on customer portal pages.

These widgets display read-only elds on the customer portal.

• ChannelAllDisplay—Displays Twier, YouTube, and Facebook user names that were entered by customers.

Note:  You can also dene output elds for single channels. Enter <rn:widget path="output/
FieldDisplay" name="Contact.ChannelUsernames.TWITTER.Username" /> to add the Twier channel.
Change the name aribute to Contact.ChannelUsernames.YOUTUBE.Username for YouTube and
Contact.ChannelUsernames.FACEBOOK.Username for Facebook.

• CustomAllDisplay—Displays the data entered into any of the contact or incident custom elds being displayed
on the page. You can also add individual custom elds by deleting this widget and adding only the ones you
want using the DataDisplay widget.

• DataDisplay—Displays the label and value of the eld dened by the name aribute in the widget code.

• FieldDisplay—Displays the label and value of the eld dened by the name aribute in the widget code. This
widget cannot display File Aachment, Hiermenu, or Thread data types.

• FileListDisplay—Displays le aachments for an incident or answer.

• IncidentThreadDisplay—Displays all correspondence associated with an incident.

• ProductCatalogDisplay—Displays the product associated with an asset.

• ProductCategoryDisplay—Displays the product or category hierarchy associated with the answer, incident, or
contact.

• ProductCategoryImageDisplay—Displays an image for a specied product or category ID.

Text Input Field Lengths  
Use the maximum_length and minimum_length aributes to restrict the number of characters entered in a text eld.

You can add these aributes to the TextInput and RichTextInput widgets. Many elds have a maximum eld size dened
in their database denitions. You can view these by clicking the eld name on the Business Object page of the Customer
Portal Administration site. If you set the maximum_length aribute of a TextInput or FormInput eld to a value larger
than the database maximum eld size, the aribute value will be ignored. Seing the minimum_length aribute to a
value greater than 0 automatically makes the eld required.

Edit the widget code to add the maximum_length or minimum_length aribute to the widget, as shown in this example.
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<rn:widget path="input/FormInput" name="Incident.Subject" required="true" maximum_length="200" />

Field Hints  
You can add a hint to help customers complete a eld.

If the eld is created using the CustomAllInput, DateInput, FormInput, ProductCategoryInput, SelectionInput, or
TextInput widget, you can use the hint aribute. By default, eld hints appears when the cursor is in the input eld.
To display the hint regardless of cursor location, set the always_show_hint aribute of the FormInput widget to true. To
hide the hint, set the hide_hint aribute to true. If you add the hint aribute to a widget that calls a custom eld, the
customer portal hint overrides any hint that was dened for the eld on the administration interface. The hide_hint
aribute can be used with CustomAllInput and CustomAllDisplay widgets.

You can also dene and display product and category selection hints by using the hint and always_show_hint aributes
for the ProductCategoryInput widget.

Edit the widget code to add the hint aribute to the widget, as shown in this example.

<rn:widget path="input/FormInput" name="Contact.Login" required="true"
validate_on_blur="true" label_input="#rn:msg:USERNAME_LBL#"
hint="Enter a username or just use your email address" />

Depending on the length of your hints, you may want to consider editing your page to accommodate them. You can
also edit the width of the hint box by changing the max-width denition in the CSS les for the DateInput, SelectionInput,
and TextInput widgets.

As an example, the default base.css le for the TextInput widget uses this code:

.rn_TextInput .rn_HintBox {
 border:1px solid #DBDBDB;
 max-width:200px;
 padding:4px 16px 2px;
 word-wrap:break-word;
}
.rn_TextInput .rn_HintBox.rn_AlwaysVisibleHint {
 max-width:300px;
 opacity:1.0;
 z-index:0;
}

It’s always good practice to include a hint when you ask customers to enter data into an object with a system aribute.
Likewise, you will want to set the always_show_hint aribute to true. This is especially true if your system aribute
requires a regular expression with a specied format, such as a product registration number or a catalog number.

Mask Characters  
You can use masks to dene custom eld formats.

Custom elds may have masks that dene their format for correct data entry. For example, you might want to ensure
that serial numbers have the correct sequence of leers, numbers, and formaing characters. The system phone
number and postal code elds can be dened on the Countries editor of the administration interface to use masks as
well.

On the reference implementation, the CustomAllInput, FormInput, and TextInput elds have an always_show_mask
aribute that displays the expected (and allowable) input format to help the customer enter the value correctly. By
default, the aribute is set to true.

To hide the mask, set the aribute to false as shown in this code.
<rn:widget path="input/CustomAllInput" table="Contact" always_show_mask="false"/>
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Note:  If you add a phone number or postal code input eld to a page and set the always_show_mask aribute
to true, you must also include the Country eld on the page. Without a customer selection in the Country eld,
the phone number and postal codes elds have no way to be associated with the correct mask.

Field Validation  
You can require eld validation to verify customer data.

You may want your customers to validate a eld entry by re-entering their information. For example, it’s not uncommon
to require customers to add their email address a second time as a way of verifying it. Rather than placing a second
FormInput widget on the page for the email address conrmation, you can add the require_validation aribute to
the rst widget. (The require_validation aribute is an aribute of the TextInput widget, which is contained in the
FormInput widget.)

This example uses eld validation on the Create an Account page.

<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
validate_on_blur="true" initial_focus="true" label_input="#rn:msg:EMAIL_ADDR_LBL#"
 require_validation="true" />

Custom Field Options  
Contact, incident, and answer custom elds can be input and displayed on the customer portal.

Custom elds are dened on the administration interface and have these options.

• Read-only—meaning they can only be displayed as an output widget.

• Read/Write—meaning they can be used for both input and output elds.

• Required—the eld is mandatory on the customer portal.

• Hint—providing additional information to customers who are entering data in the eld.

• Default value—automatically populating the eld if the data type is integer, menu, text area, text eld, yes/no,
or opt-in.

These four elements of a custom eld—hint, default value, customer portal read-only or read/write visibility, and
whether it’s required—that are dened on the administration interface can be modied through aributes of the input
widget used to display the custom eld.

• Hints—If you dene the hint aribute of an input widget for a custom eld, the hint aribute denition dened
in the widget code will override whatever hint was dened on the administration interface.

• Default value—If you dene the default_value aribute of an input widget for a custom eld, that aribute
value will override whatever value was dened on the administration interface.

• Visibility—Custom elds marked Read can be used with output widgets, but you will get a widget error message
on the page if you try to use them with an input widget. Custom elds marked Read/Write can be used for both
input and output widgets.

• Required—If you set the required aribute of an input widget for a custom eld to false in the widget code
when the custom eld is marked as required on the administration interface, you cannot override the
requirement with Customer Portal code. If the custom eld is not dened as required on the administration
interface, you can require it on your customer portal if you set the required aribute of the input widget to true.
In other words, the required widget aribute can only make a non-required eld required, but it cannot make a
required eld not required.
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Input Field Values  
Input elds are either blank or populated with a value, depending on how you dene the eld.

Customers can enter data in blank input elds, and they can override default values in elds that are already populated.
(If you don’t want customers to change the value of a eld, use one of the read-only output widgets instead of an input
widget.)

There are multiple ways the value of an input widget can be set.

• If the input widget is used with a custom eld, the eld’s default value may be set on the administration
interface when the custom eld is added.

• The value can be dened using the default_value aribute of the input widget when you add the widget code
to a page. In this case, the input eld always contains the dened default value when the page opens. If the eld
is a custom eld with a default value that was dened when it was created, the widget’s default_value aribute
overrides the value set on the administration interface.

• You can pass the input eld’s value in the URL that opens the page. You might want to use this option if you
have multiple ways to open a page. Here’s a simple example: Assume your organization sells printers and
monitors. You have one web page just for printers and another for monitors, each with a link to the Ask a
Question page on your customer portal. You want to populate the Product eld to identify whether customers
accessed the Ask a Question page from the printer page or the monitor page. You can dene the product type
in the page’s URL so that the Product eld is populated correctly based on which link was clicked to open the
page.
If you pass a eld’s value through the page URL when the eld’s value was already dened with the input
widget’s default_value aribute, the URL value overrides the widget aribute.
You can also pass the default value of the input eld through a POST parameter.

• The customer enters a value for the eld. This value overrides any other predened value.

Populate the Subject Field  
This example populates the Subject eld on the Ask a Question page.

1. Open /views/pages/ask.php.
2. Locate this code. These lines are not sequential.

<rn:widget path="input/FormInput" name="Incident.Subject" required="true" />
...
<rn:widget path="input/FormInput" name="Incident.Subject" required="true" initial_focus="true"/>

One FormInput eld is dened for the condition when customers are not logged in, and the second is for
logged-in customers.

3. Add the default_value aribute to the FormInput widget to dene the value in the Subject eld.
<rn:widget path="input/FormInput" name="Incident.Subject" required="true" default_value="Product
 Registration" />
...
<rn:widget path="input/FormInput" name="Incident.Subject" required="true" initial_focus="true"
 default_value="Product Registration"/>

4. Save the le.

Populate Default Product and Category Values  
This example populates the product and category elds on the Submit a Question page with preset values.

1. Open /views/pages/ask.php.
2. Locate this code.
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<rn:widget path="input/ProductCategoryInput" name="Incident.Product"/>

3. Add the default_value aribute to the ProductCategoryInput widget.
<rn:widget path="input/ProductCategoryInput" name="Incident.Product" default_value="21,47" />

4. Locate this code.
<rn:widget path="input/ProductCategoryInput" name="Incident.Category" />

5. Add the default_value aribute to the widget.
<rn:widget path="input/ProductCategoryInput" name="Incident.Category" default_value="98"/>

6. Save the le.

Set a Custom Date/Time Value  
You can set a value for a custom date or date/time eld.

This example assumes you’ve added a custom Answer Needed By eld to the Ask a Question page. If you want to set a
default value for the eld, add this code to the Ask a Question page.

<rn:widget path="input/DateInput" name="Incident.CustomFields.c.answer_needed" default_value="1435920435"/>

You can use a UNIX date/time stamp converter to generate the value.

You can also enter absolute and relative dates, which the PHP strtotime( ) function will convert to a UNIX time stamp
format. Absolute dates must be entered using the English date format of dd/mm/yyyy.

These values for the default_value aribute of a DateInput widget are valid, and more examples can be found in the
PHP strtotime( ) documentation.

• Now

• 18-12-2015

• December 18, 2015

• Tomorrow

• Today + 2 months

• First day of next month

• Next Wed + 4 days

When adding the custom eld to the page, use this code if you want the value of the eld to be populated automatically,
relative to the current date/time.

<rn:widget path="input/DateInput" name="Incident.CustomFields.c.answer_needed" default_value="tomorrow" />

Note:  The standard date/time elds are read-only, so you cannot set values for those.

Set a Yes/No Field  
The SelectionInput widget is used to display Yes/No radio buons for a custom eld.

This example assumes you’ve added a custom eld to a page that asks if the person submiing the question is a current
customer. It also assumes you want to set the default value of the widget to Yes. To set it to No, set the default_value
aribute to 0 or false. Add this code to the page.

<rn:widget path="input/SelectionInput" name="Contact.CustomFields.c.current_cust" default_value="1"/>
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Alternately, you could set the value to true.

<rn:widget path="input/SelectionInput" name="Contact.CustomFields.c.current_cust" default_value="true"/>

If default_value is set to anything other than 1, 0, true, or false, neither selection appears.

Change Radio Buons to a Check Box  
You can change the default radio buons to check boxes using the display_as_checkbox aribute.

If you’d prefer to display yes/no elds as a single check box instead of as radio buons, simply add the
display_as_checkbox aribute to the SelectionInput widget.

<rn:widget path="input/SelectionInput" name="Contact.CustomFields.c.current_cust"
display_as_checkbox="true" />

When this aribute is set to true, the customer’s response is saved as Yes if the check box is selected and No if the check
box is not selected.

Set a Menu Option  
You can populate menu options on a drop-down menu by modifying the custom eld code.

To set a default option in a drop-down menu, you’ll use the FormInput widget and use the ID of the option. This
example includes a menu custom eld to dene the urgency of the incident, and it sets the urgency to Normal.

To nd the ID of a custom eld option, open the page in source code view, search for the menu custom eld, note the
<option> tags, and nd the value you want to set.

Add this code to the page.

<rn:widget path="input/FormInput" name="Incident.CustomFields.c.urgency" default_value="1"/>

Populate the Subject Field Using a URL  
This example denes a default value for an input eld in the URL that opens the page containing the eld.

Although this example shows you how to populate a eld with a URL within your customer portal, you’re more likely to
populate an input eld value to access the Ask a Question page from an external page. If you dene a eld’s value in
the URL that calls the page and if that default value is also dened in the code for the input widget, the value in the URL
overrides the value specied in the widget code.

1. Open /views/templates/standard.php.
2. Edit the navigation tab for the Ask a Question page.

a. Locate this code.
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#"
link="/app/ask" pages="ask, ask_confirm"/></li>

b. Edit the link aribute to use the URL to populate the Subject eld.
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#"
link="/app/ask/Incident.Subject/From the Navigation Tab" pages="ask, ask_confirm"/></li>

3. Save the le.

POST Parameters and Populating Fields  
You can use POST parameters from forms you create to populate those elds.
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Similar to using URL parameters to populate contact and incident input elds, you can also use POST parameters
to populate elds. As with URL parameters, the POST parameter must use the Table.Field format, for example,
Incident.Subject.

How You Display Values without Labels  
You can output eld values without labels or formaing by using the Field page tag.

When you don’t need a label or any special formaing, you can use the rn:field page tag to output the value of the
eld. All you need to do is specify the table and eld names, just as you do when dening an output widget.

For example, you can use this code on the ask_conrm.php page to display the customer’s incident number.

<a href="/app/#rn:config:CP_INCIDENT_RESPONSE_URL#/i_id/#rn:url_param_value:i_id##rn:session#">
#<rn:field name="Incident.ReferenceNumber" /></a>.

Allow Edits to Fields After Login  
You can change input elds on the Account Seings page so customers can edit them.

1. Open /views/pages/account/prole.php.
2. Locate this code.

 <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address"
required="true" validate_on_blur="true" initial_focus="true"
label_input="#rn:msg:EMAIL_ADDR_LBL#"/>
 

3. Edit the code to add the allow_external_login_updates aribute.
<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address"
required="true" validate_on_blur="true" initial_focus="true"
label_input="#rn:msg:EMAIL_ADDR_LBL#" allow_external_login_updates="true" />

4. Save the le.

Add a System Aribute Using the FormInput Widget  
This example uses the FormInput widget to add a contact system aribute to the Ask a Question page asking customers
if they have used a previous version of the product.

1. Open /views/pages/ask.php.
2. Locate <rn:widget path="input/FileAttachmentUpload"/>.
3. Add this code after <rn:widget path="input/FileAttachmentUpload"/>.

<rn:widget path="input/FormInput" name="Contact.CustomFields.CO.usedpreviousproducts"
always_show_hint="true" hint="Have you used a previous version of this product?" />

<rn:widget path="input/FileAttachmentUpload"/>
<rn:widget path="input/FormInput" name="Contact.CustomFields.CO.usedpreviousproducts"
always_show_hint="true" hint="Have you used a previous version of this product?" />

4. Save the le.

Add a System Aribute Using the DataDisplay Widget  
This example adds a Product Registration section to the Account Overview page.

1. Open /views/pages/account/overview.php.
2. Add this code where you want it to appear on the page.

<div class="rn_Overview">
 <h2><a class="rn_Questions" href="/app/account/questions/list#rn:session#">
 Product Registration</a></h2>
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 <div class="rn_Questions">
 <rn:widget path="output/DataDisplay" name="Contact.CustomFields.CO.product_registration"
 label="Registered Product"/>
 <rn:widget path="output/DataDisplay" name="Contact.CustomFields.c.date_registered"
 label="Date Registered"/>
 </div>

3. Save the le.

Add a System Aribute Using Regular Expressions  
This example adds an RMA system aribute to incidents.

For this example, we’ll assume that you’ve added an RMA system aribute to incidents so that you can match the
incident with your organization’s Return Merchandise Authorization process. We’ll also assume that you’ve dened the
format of the RMA system aribute to use the paern AA-#####, for example, CX-49935.

1. Open the page where you want to add the system aribute.
2. Add the FormInput widget to the code so it appears where you want it to on the page.

<rn:widget path="input/FormInput" name="Incident.CustomFields.CO.RMA" always_show_hint="true"
hint="Expected Input: AA-##### (for example, CX-49935)" validate_on_blur="true"
label_input="Returned Merchandise Authorization" />

Note:  If the regular expression (the AA-##### paern) is not met, the validate_on_blur aribute
indicates an error as soon as customers move to a dierent eld. Without this aribute, the error is not
pointed out until customers click the Continue buon.

3. Add the hint directly to the eld name.
<rn:widget path="input/FormInput" name="Incident.CustomFields.CO.RMA" label_name=
validate_on_blur="true" label_input="RMA (expected input: AA-#####)" />

4. Save the page.

Web Form Security  
The Customer Portal includes web form security on the FormSubmit widget that automatically requires human
validation when abuse is suspected.

Validation is accomplished through the use of a CAPTCHA, a dialog containing distorted words that the customer is
asked to type. When the words are typed correctly, a human is assumed to be on the client side. Customers who have
correctly entered a CAPTCHA will not be asked for verication again as long as the visit has not ended or does not
exceed an hour.

You may also want to require CAPTCHAs to prevent user name enumeration, that is, the automatic harvesting of user
names from your database.

By default, a CAPTCHA opens on the customer portal only when the system detects abuse, but you can congure a form
to always require human validation. You can also congure a form to open a CAPTCHA wherever you want on the form
instead of in a dialog, where it opens by default.

CAPTCHAs are not used with pass-through authentication. Nor are they used on the basic page set. CAPTCHAs require
JavaScript to display and the basic page set does not support JavaScript. Therefore, if an abuse situation is detected on
your basic page set, customers will see a generic error message rather than a CAPTCHA.
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Require CAPTCHA Validation on Submit  
This example demonstrates seing a CAPTCHA validation for all form submials.

1. Open the page containing the form where you want a CAPTCHA to always appear.
2. Locate the code for the FormSubmit widget, <rn:widget path="input/FormSubmit".
3. Edit the FormSubmit widget code to add the challenge_required aribute.

<rn:widget path="input/FormSubmit" label_button="#rn:msg:CREATE_ACCT_CMD#"
on_success_url="/app/account/overview" error_location="rn_ErrorLocation"
challenge_required="true" />

4. Save the page.

If you want to test a CAPTCHA on a page, you can temporarily set the challenge_required aribute to true, as shown in
this example. When your testing is complete, you can remove the aribute from the widget code so that a CAPTCHA
appears only when abuse is detected.

Open CAPTCHA Within a Form  
This example code lets you open the CAPTCHA within a form.

1. Open the page containing the form where you want the CAPTCHA to appear.
2. Locate the code for the FormSubmit widget, <rn:widget path="input/FormSubmit".
3. Edit the widget code to add the challenge_location aribute and set the aribute equal to the div ID for

CaptchaArea.
<rn:widget path="input/FormSubmit" label_button="#rn:msg:CONTINUE_ELLIPSIS_CMD#"
on_success_url="/app/ask_confirm" challenge_required = "true"
challenge_location="captchaArea" error_location="rn_ErrorLocation"/>

4. Add <div id="captchaArea" class="rn_CaptchaDialog"> to the page.
<rn:widget path="input/FormSubmit" label_button="#rn:msg:CONTINUE_ELLIPSIS_CMD#"
on_success_url="/app/ask_confirm" challenge_required = "true"
challenge_location="captchaArea" error_location="rn_ErrorLocation"/>

<div id="captchaArea" class="rn_CaptchaDialog">

5. Save the page.

Set the Abuse Detection Cookie  
The Abuse Detection Cookie allows you to test your development site.

An abuse scenario is hard to create deliberately for testing purposes, so the Customer Portal includes a cookie that
makes your site behave as if it is under abuse when the cookie is set. It works only in development mode for testing
purposes.

1. To set the abuse detection cookie,

◦ On your Customer Portal Administration site, click  Set Environment > Trigger Abuse Detection .

◦ On your development site, click  the development header > Links and Resources > Toggle Abuse
Detection .

Remove ClickjackPrevention from the Template  
If your site runs in frames, you should remove the ClickJackPrevention widget.

Clickjacking is an aack on browser security that can mislead your customers into clicking a concealed link. To prevent
clickjacking, you must not allow your site to be put into an iFrame or frameset on another site.

1. Open customer/development/view/template/standard.php.
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2. Delete this line of code.
<rn:widget path="utils/ClickjackPrevention"/>

3. Save the page.

Syndicated Widgets  
You can use a syndicated widget to access the Oracle knowledge base from another web page outside of your customer
portal.

These are the syndicated widgets.

• ConditionalChatLink

• KnowledgeSyndication

• PollingSyndication

• ProactiveChat

• ProactiveSurveyLink

The syndicated widgets are generated with JavaScript code that can be placed within another web page. You can
congure the widgets by modifying the JavaScript or by using the widget denition page to dene the conguration
options and seings.

The widgets can be completely styled with their CSS les, which are found in the /cp/customer/assets/css/
syndicated_widgets/standard folder. You can review and modify the seings for a syndicated widget at hps://
<your_site>/ci/tags/syndicated_widgets.

The KnowledgeSyndication Widget  
The KnowledgeSyndication widget provides search access to your knowledge base.

This widget acts like the search elds and reports on the Support Home and Published Answers pages of your customer
portal, but you can place it on any page of your website, leing your customers search the Oracle knowledge base from
any of your organization’s website pages.

By default, the KnowledgeSyndication widget displays a search eld, a list of answers from the knowledge base, and a
link to additional results on the customer portal pages. This widget can be congured to display spelling corrections and
suggestions, recommended documents, and other suggested searches. It can open an answer in a page overlay or on a
new page. You can also edit labels and congure the number of displayed answers, whether to display a description of
each answer and, if so, the length of the description.

If you have enabled web indexing, the KnowledgeSyndication widget will also search external documents.

Add the KnowledgeSyndication Widget to a Page  
The widget information page gives you everything you need to add the KnowledgeSyndication widget to any page on
your website.

Your prole must have the CP Edit permission enabled and you must log in to the Customer Portal Administration site if
you are not already logged in.

1. Enter https://<your_site>/ci/tags/syndicated_widgets/standard/KnowledgeSyndication to open the page for
the KnowledgeSyndication widget.

2. In the Congure Widget section, modify the widget aributes.
3. To preview your changes, click Apply.
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4. Open the source code for the web page you want to add the widget to.
5. On the widget page, click the top Select Text buon to select the code in the rst box and copy the code.
6. Paste the code into your web page le just before the closing </body> tag.

Even if you plan to use multiple syndicated widgets on the page, you need to paste this code only once.
7. On the widget page, click the second Select Text buon and copy the code that denes the widget.
8. Paste the copied code just below the code you pasted in step 6.
9. Add <div_id="myDiv"></div> to the page code where you want the widget to appear.

10. Save the page.

Congure the KnowledgeSyndication Widget  
You can congure all aributes of the KnowledgeSyndication widget.

In order to return external documents from a search, you must enable web indexing.
1. To enable external document searching, select the check box for the ext_docs aribute.
2. To open answers in an overlay instead of a separate window, select the check box for the

display_answers_in_overlay aribute.
3. To dene products for a KnowledgeSyndication widget report, enter the product ID in the eld for the p

aribute.
4. To dene categories for a KnowledgeSyndication widget report, enter the category ID in the eld for the c

aribute.
5. To retain the product and category search lters, select the check box for the persist_prodcat aribute.
6. To use context-sensitive information to determine what answers should be returned, enter comma-separated

HTML tags in the eld for the context aribute.
7. To dene the number of characters that will be evaluated for each tag, enter the number in the eld for the

payload_size aribute.
8. To hide answers until a search is performed, select the check box for the hide_initial_answers aribute.
9. To set a keyword for a search query, enter the search word in the eld for the q aribute.

Note:  If you’ve entered HTML tags in the context aribute, any values in the q aribute will be
overridden.

10. To disable spelling corrections and suggestions, clear the check box for the correction aribute.
11. To disable answer descriptions in the search results, clear the check box for the description aribute.
12. To disable the More Results link, clear the check box for the navigation aribute.
13. To disable recommended documents, clear the check box for the recommended aribute.
14. To disable suggested searches, clear the check box for the related aribute.
15. To disable the keyword search box to prevent customers from entering search terms, clear the check box for the

search_box aribute.
16. To edit the default spelling suggestion label of “Did You Mean,” enter the new label in the eld for the

label_correction aribute.
17. To edit the label for recommended documents, enter the new label in the eld for the label_documents aribute.
18. To edit the label for the More Results link, enter the new label in the eld for the label_more_results aribute.
19. To edit the No Results Found label, enter the new label in the eld for the label_no_results aribute.
20. To edit the related searches label, enter the new label in the eld for the label_related_searches aribute.
21. To edit the Search buon label, enter the new label in the eld for the label_search_button aribute.
22. To edit the Created label, enter the new label in the eld for the label_created aribute.
23. To edit the Updated label, enter the new label in the eld for the label_updated aribute.
24. To change the target window that denes where linked documents and additional search results open, enter

one of the following target values for the HTML anchor (<a>) tag in the eld for the widget’s target aribute.
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◦ _blank—Opens the link in a new window.

◦ _self—Opens the link in the current window.

◦ _parent—Opens the link in the parent frameset.

◦ _top—Opens the link in the full window.

25. To edit the length of answer descriptions from the default of 100 characters, enter a numerical value in the eld
for the truncate_size aribute.

26. To change the number of displayed answers from the default of ten, enter an integer in the eld for the
number_answers aribute.

27. To edit the div element, enter a new name for the div element in the eld for the div_id aribute.
28. To edit the instance ID, replace the “0” in “skw_0” in the instance_id aribute with another value for each

widget you add to the page.
29. Click Apply.

How the KnowledgeSyndication Widget Determines Search Results  
The KnowledgeSyndication widget can use context-sensitive information on a page to determine what answers to
return.

The KnowledgeSyndication widget evaluates a page for context sensitivity when you specify the HTML tags on
the page. If you leave the eld for this aribute blank, the KnowledgeSyndication widget will not use page content
to determine what answers should be returned. You can also dene the amount of content you want the widget to
evaluate.

When you specify the page tags, the content within those tags is passed to the server for evaluating answers that are
relevant to the page content. You might, for example, want to place the KnowledgeSyndication widget on your product
pages so the specic product information from each page is used to return product-specic answers to your customers.

If you enter information in the context aribute’s eld, the keyword for the search query dened in the q aribute is
overridden. If the HTML tags you dene are not found on the page, the widget defaults to the empty string, and top
answers will be returned.

You can list any div ID, as well as title, document, and meta tags in the eld for the context aribute. If you list a meta
tag, only meta elements that are named description and keywords will be evaluated. If you use a document tag, the
entire contents of the page will be evaluated.

The payload_size aribute of the KnowledgeSyndication widget denes the number of characters for each tag identied
in the context aribute that will be sent to the server for evaluation to determine page content and inuence context
sensitivity of the returned answers. The default value is 150 characters (approximately 25 English words), and the
maximum value is 300 characters.

Inlays and Customer Portal  
Inlays are the next generation of syndicated widgets.

These are objects that you can place on any web page to invoke specic customer service interactions. They are
packaged units of functionality, such as chat interactions, viewing knowledge articles and service request creation. The
name Inlays refers to the design of these components and that you can inlay them into any web page, including your
external web site, seamlessly.

Inlays are single version, so there is no need to migrate or update your current Inlay implementation. The release cycle
for Inlays is typically every 2-4 weeks.
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For more information, see the inlay documentation at hps://documentation.custhelp.com/s/oit/latest.

Polling Widgets  
Polling widgets let you add a single-question poll from surveys that have been created on the agent desktop.

The Polling widget is located in the standard widgets folder in the surveys subfolder. The PollingSyndication widget can
be found on the Customer Portal Administration site by clicking the Widgets tab and selecting Syndicated Widgets.

The available question types include choice, text, and matrix, and you can use any of these question types in your poll,
although the choice question type probably oers the most usefulness to your organization. When customers answer
a choice question by selecting a menu item, option, check box, or list item, they see a chart displaying the responses
to date. (This chart can be a horizontal bar chart, vertical bar chart, or pie chart.) When customers respond to text and
matrix questions, they see a thank you message.

If the survey you have associated with the polling widget contains multiple questions, one of the questions will be
selected at random to appear to customers for a one-hour time period. Every customer who is oered the poll during
that time sees the same question. At the end of an hour, a new question is selected at random.

Customer visits that result from clicking the PollingSyndication widget are tracked as Oracle Feedback Cloud Service
visits, not as Customer Portal visits.

Polling Widget Aributes  
These aributes are available for the standard Polling widget and the PollingSyndication widget.

The question, answers, and some styling options are dened on the agent desktop when surveys and associated
questions are created. Additional styling and other aributes are dened with customer portal code. If widget styling
aributes are dierent than the styling dened when the survey was created, the widget aributes are used.

• Chart Style—Sets the styling for the chart using the YUI Charts Control. You can specify backgrounds, borders,
colors, fonts, and many other chart aributes. The default is blank.

• Chart Type—Species the chart type. Options include none, horizontal bar, vertical bar, pie chart, and simple.
The default is a horizontal bar chart.

• Cookie Duration—Denes the number of days until the cookie expires. The default is ten days.

• Instance ID—Denes the ID for the widget instance. You can specify this value, or it will be selected
automatically.

• Frequency—Denes what percentage of visitors are oered the poll. This aribute is used only when modal
polls are enabled.

• Modal—Sets the survey dialog to be modal. This mode requires customer interaction to close the dialog. By
default, the modal poll is disabled.

• Poll Logic—Prevents the survey dialog from opening unless the evt_showPoll event is red. This aribute is
used only when modal polls are enabled. You must add code to dene the condition that triggers the event.

• Seconds—Used only with modal polls to specify the time in seconds until the dialog is opened. The default
value is 0.

• Series Style—Sets the styling for the chart’s bars or pie wedges with the YUI Charts Control.

• Survey ID—Required to identify the polling survey the widget uses.

• Test—Puts the widget in test mode so results are not recorded.
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Add the Polling Widget to a Page  
You congure the Polling widget by placing widget code on the customer portal page where you want it to appear and
then editing its aributes.

1. Open the le for the page where you want to place the Polling widget.
2. Enter the code for the Polling widget in the location where you want the widget to appear on the page.

This is an example of the most basic widget code. The value of the survey_id aribute is the ID of the survey
containing the polling question you want to use.
<rn:widget path="surveys/Polling" survey_id="8" />

Every Polling widget must include a value for the survey_id aribute. If it does not, an error message appears
on the customer portal page.

3. Save the le.

Add the PollingSyndication Widget to an External Page  
This example describes the process for adding the PollingSyndication widget to an external page.

1. Enter https://<your_site>/ci/tags/syndicated_widgets/standard/PollingSyndication to open the page for the
PollingSyndication widget.

2. In the Congure Widget section, edit the widget aributes.
3. To preview your changes, click Apply
4. Continue to congure the widget until you are satised with the result.
5. Open the source code for the web page you want to add the widget to.
6. On the widget page, click Select Text and copy the code.
7. Paste the code into your page le just before the closing </body> tag.

Even if you plan to use multiple syndicated widgets on the page, you need to paste this code only once.
8. On the widget page, click the second Select Text and copy the code that denes the widget.
9. Paste the copied code just below the code you pasted in previous steps.

10. On the widget page, click the third Select Text, copy the code, and paste it where you want the widget to
appear.

11. Save the page.

Add the Survey ID to the Polling Widget  
You can specify the survey used by the polling widget.

Every polling widget must be associated with a polling survey that was designed on the Service Console. If the survey ID
is missing from the Polling widget code, you will see an error on the page where you are trying to place the widget.

1. Click Surveys.
2. Double-click Surveys Explorer.
3. Click Choose Details.
4. Select ID.
5. Click OK.
6. Add the survey_id aribute to the widget code.

<rn:widget path="surveys/Polling" survey_id="5" />

Dene the Cookie Duration for the Polling Widget  
You can dene the life of the cookie or you can prevent a cookie from being set.

After a customer has answered the poll, a cookie is set to prevent the survey from being oered again when the
customer visits the page in the future.

1169



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

When the poll opens in a separate dialog instead of as an element on the page (a modal poll), the survey is not
presented again after the customer has responded, even if the randomization process now presents a dierent question
to customers. In the non-modal mode after a customer has answered the poll, subsequent visits to the site, when the
cookie is active, will display only the survey results instead of the survey question that appeared on the rst visit.

1. Add the cookie_duration aribute to the widget code.
2. Set the aribute value for the number of days you want the cookie to remain active.

<rn:widget path="surveys/Polling" survey_id="5" cookie_duration="5"/>

3. To dene the cookie duration for the PollingSyndication widget.
a. Open the page for the PollingSyndication widget.
b. Scroll to the Congure Widget section.
c. In the cookie_duration aribute, enter the number of days you want the cookie to remain active.

Congure Modal Polls for the Polling Widget  
This procedure demonstrates enabling and conguring the polling widget for modal polls.

1. Add the modal aribute to the widget code and set it to true.
<rn:widget path="surveys/Polling" survey_id="5" modal="true" />

2. To oer the poll to only a percentage of your customers instead of all of them, add the frequency aribute to the
widget code.
<rn:widget path="surveys/Polling" survey_id="5" modal="true" frequency="50"/>

3. To trigger the dialog on the event dened in evt_showPoll, add the poll_logic aribute to the widget code.
<rn:widget path="surveys/Polling" survey_id="5" modal="true" poll_logic="true"/>

4. To trigger the dialog after the page has been open a specied number of seconds, add the seconds aribute to
the widget code.
<rn:widget path="surveys/Polling" survey_id="5" modal="true" seconds="3" />

Congure Modal Polls for the PollingSyndication Widget  
This procedure demonstrates enabling and conguring the PollingSyndication widget for modal polls.

1. With the page for the PollingSyndication widget open, scroll to the Congure Widget section.
2. Select the modal aribute check box.
3. To oer the poll to only a percentage of your customers, nd the frequency aribute and enter a percentage

value in the eld.
4. To trigger the dialog on the event dened in evt_showPoll, select the poll_logic aribute check box.
5. To trigger the dialog after the page has been open a specied number of seconds, nd the seconds aribute

and enter the number of seconds in the text eld.

Use Poll Logic with Widgets  
You can use a JavaScript event to display the polling widget when modal polls are enabled.

A JavaScript event, evt_showPoll, lets you use logic to display the polling widget when modal polls are enabled. When
the poll_logic aribute is set to true, the polling dialog does not display unless the evt_showPoll event is triggered.

1. Add the poll_logic aribute to the widget code.
<rn:widget path="surveys/Polling" survey_id="4" modal="true" poll_logic="true" />

2. Then add code to trigger the evt_showPoll event.
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If, for example, you want to trigger the poll after customers click a link on the widget, you could add the
following code to the page containing the widget. (Notice that the widget code prevents cookies from being set
so the link will remain active.)
<rn:widget path="surveys/Polling" survey_id="4" modal="true" poll_logic="true" cookie_duration="0" />
 <script type="text/javascript">
 function pollLogic() {
 RightNow.Event.fire('evt_showPoll');
 }
 </script>
 <a href="#" onclick="pollLogic()"><h2>Help us serve you better by taking this poll.</h2></a>

3. To add the poll to the PollingSyndication widget, add the logic code to the external page below the code you
added for the PollingSyndication widget.
The following example shows the code you might add if you want to display the poll 500 milliseconds after the
page opens.
<script type="text/javascript">
var rnTimer;
startCheck();

// check to see when the RightNow javascript is loaded and ready to use
function startCheck()
{
 rnTimer = setInterval(checkLoaded, 500); // this is milliseconds
}

// when loaded fire the poll
function checkLoaded()
{
 if (RightNow && RightNow.Client && RightNow.Client.Event && RightNow.Client.Event.evt_showPoll)
 {
 clearInterval(rnTimer);
 RightNow.Client.Event.evt_showPoll.fire();
 }
}
</script>

Edit the Chart Type on Polling Widgets  
You can change the type of chart the page uses to display the poll results of a choice type question.

1. To display a vertical bar chart, add the chart_type aribute to the widget code and set its value to vertical_bar.
<rn:widget path="surveys/Polling" survey_id="5" chart_type="vertical_bar" />

2. To display a pie chart, add the chart_type aribute to the widget code and set its value to pie.
<rn:widget path="surveys/Polling" survey_id="5" chart_type="pie" />

3. To remove the display, add the chart_type aribute to the widget code and set its value to none.
<rn:widget path="surveys/Polling" survey_id="5" chart_type="none" />

4. To edit the chart type on the PollingSyndicated widget:
a. Open the page for the PollingSyndication widget.
b. Scroll to the Congure Widget section of the page.
c. Find the chart_type aribute.
d. Select vertical_bar, pie, or simple.

Instance ID  
The instance_id is used as a unique identier of the polling widget.
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Each instance of a polling widget on a customer portal page or an external page must have its own instance ID.

You can enter a value for instance_id in the Polling widget code or type a value in the eld for the PollingSyndication
widget. If you do not enter a value, one will be assigned automatically.

Set Test Mode for Polling Widgets  
You can test the polling widgets without contaminating your poll results. No statistics are collected in test mode.

1. Add the test aribute to the widget code and set it to true.
<rn:widget path="surveys/Polling" survey_id="5" test="true" />

2. To set the test mode for the PollingSyndication widget:
a. Open the PollingSyndication widget page.
b. Scroll to the Congure Widget section of the page.
c. Find the aribute called test.
d. Select the check box.

Add a Survey Link to a Page  
You can use the SurveyLink widget to add a link to any customer portal page that opens broadcast surveys and website
link surveys.

1. Open the customer portal page that you want to add the SurveyLink widget to.
2. Add <rn:widget path="surveys/SurveyLink" survey_id="11"/> where you want the widget to display on the

page, dening the survey_id aribute with the ID value of the survey you want to use.
a. To use a graphic element instead of the text link to the survey, add the icon_path aribute to the widget.

<rn:widget path="surveys/SurveyLink" survey_id="11" icon_path="images/cp_survey_icon.png" />

If you want to change the graphic label, add the label_icon_alt aribute and set the value to whatever
you want the screen reader to read.

b. To open the survey in a separate window, add the target aribute to the widget code and set it to _blank.
<rn:widget path="surveys/SurveyLink" survey_id="11" target="_blank" />

c. To change “Survey Link” to dierent text, add the link_text aribute to the widget.
<rn:widget path="surveys/SurveyLink" survey_id="11" link_text="Click here to take our survey" />

3. Save the le.

Add the ProactiveSurveyLink Widget to a Page  
You can place the ProactiveSurveyLink widget on any customer portal page.

1. Open the customer portal page that you want to add the ProactiveSurveyLink widget to.
2. Add <rn:widget path="surveys/ProactiveSurveyLink" survey_id="11"/> to the page.

a. To change the labels on the Accept and Cancel buons, add the label_accept_button and
label_cancel_button aributes.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11"
label_accept_button="Yes please" label_cancel_button="No thanks" />

b. To open the survey in a separate window instead of on the same page, add the target aribute to the
widget code and set it to _blank.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11" target="_blank" />
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c. To set the cookie duration to anything other than the default value of ten days, add the cookie_duration
aribute and set it to the number of days you want to avoid presenting the survey oer again.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11" cookie_duration="0"/>

d. To change the width of the window that opens when the link is clicked from its default value of 300 pixels,
add the dialog_width aribute and set it to the value you want.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11" dialog_width="200" />

e. To dene a percentage of visitors who will be oered the survey (instead of the default value of 100), add
the frequency aribute and set it the value you choose.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11" frequency="50" />

f. To change the default invitation to participate in the survey, add the intro_paragraph aribute with the
text of your choice.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11"
intro_paragraph="Complete this survey and be entered in a drawing to win an iPad!" />

g. To open the window after a specied number of seconds, add the seconds aribute.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11" seconds="10" />

h. To change the survey title from the default “Survey Invitation,” add the title aribute.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11"
title="Tell us what you're thinking" />

i. To open the widget only when an event is red, add the wait_for_event aribute to the widget and then
add the code to re the event.
<rn:widget path="surveys/ProactiveSurveyLink" survey_id="11"
 wait_for_event="true" cookie_duration="0" /> 
<script type="text/javascript"> 
function dialogLogic() 
 { 
 RightNow.Event.fire('evt_showOffer'); 
 } 
 </script> 
 <a href="#" onclick="dialogLogic()"><h2>Help us serve you
 better by taking this survey.</h2></a>

Note:  A JavaScript event, evt_showOer, lets you use logic to display the ProactiveSurveyLink
widget. You must add code to re evt_showOer in order for the widget to open. If you have
dened the seconds aribute, the widget opens after the event has red and the number of
seconds has elapsed.

3. Save the page.

Add the Syndicated ProactiveSurveyLink Widget to a Page  
You can place the syndicated ProactiveSurveyLink widget on an external web page.

1. Enter https://<your_site>/ci/tags/syndicated_widgets/standard/ProactiveSurveyLink to open the page for the
syndicated ProactiveSurveyLink widget.

2. Scroll to the Congure Widget section and edit the widget aributes.
3. To preview your changes, click Apply.
4. Open the source code of the external page you want to add the widget to.
5. To ensure the page renders correctly in Internet Explorer 7, add <!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0

Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> to the top of the page before
your rst HTML tag.
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6. On the right side of the widget page, click the top Select Text and copy the code.
7. Paste the code into your page le just before the closing </body> tag.

Even if you plan to use multiple syndicated widgets on the page, you need to paste this code only once.
8. Click the second Select Text and copy the code that denes the widget.
9. Paste the copied code just below the code you pasted earlier.

10. Click the third Select Text buon, copy the code, and paste it where you want the widget to appear on the
page.

11. Save your web page.

Congure the Syndicated ProactiveSurveyLink Widget  
You can customize the syndicated ProactiveSurveyLink widget.

1. Open the Syndicated ProactiveSurveyLink Widget page.
a. Scroll to the Congure Widget section.
b. In the survey_id aribute eld, enter the ID number of the survey you want to use.

2. To set the cookie duration to anything other than the default value of ten days, enter the number of days you
want to avoid presenting the survey oer again in the cookie_duration aribute. If you set the value to 0, no
cookie is set.

3. To change the width of the window that opens when the link is clicked from its default value of 300 pixels, enter
the new value in the dialog_width aribute.

4. To open the widget only when an event is red, select the Enabled check box for the display_logic aribute.

Note:  A JavaScript event, evt_showLink, lets you use logic to display the syndicated
ProactiveSurveyLink widget. You must add code to re evt_showLink in order for the widget to open. If
you have dened the seconds aribute, the widget opens after the event has red and the number of
seconds has elapsed.

5. Add this code just below the widget code on the page where you’re placing the widget.
<script type="text/javascript"> 
 function dialogLogic() 
 { 
 RightNow.Client.Event.evt_showLink.fire();
 } 
</script> 
<a href="#" onclick="dialogLogic()"><h2>Help us serve you better by taking this survey.</h2></a>

6. To change the div_id aribute from its default of myDiv, enter a new name for the div in the eld.
7. To dene a percentage of visitors who will be oered the survey (instead of the default value of 100), set the

percentage value you want in the frequency aribute.
8. To rename the instance_id aribute, replace the “0” in “psl_0” with another value.
9. To change the default invitation to participate in the survey, enter text for the new introduction in the

intro_paragraph aribute.
10. To change the labels on the Accept and Cancel buons, enter new values for the label_accept_buon and

label_cancel_buon aributes.
11. To open the survey link window after a specied number of seconds, enter the value in the seconds aribute.
12. To open the survey in a separate window instead of on the same page, click the drop-down arrow for the target

aribute and select “_blank.”
13. To change the survey title from the default “Survey Invitation,” enter the new title in the title aribute.

Standard Widgets  
There are widgets included in both the standard and mobile customer portal reference implementations.
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Widgets Not Used in Reference Implementation

Widget Page Widget functionality on the page

templates/standardAccountDropdown

templates/mobile

Displays a drop-down menu of account options to logged-in users
and a login link to users who are not logged in.

ActivityCharts social/moderate/overview Displays counts for recent new community discussions and users
on the Moderation Overview page.

AnnouncementText social/moderate/overview Displays an announcement to community moderators.

answers/detailAnswerFeedback

mobile/answers/detail

Displays the Was This Answer Helpful? section of the page,
 including the Yes/No buons, and feedback dialog.

AnswerNoticationIcon answers/detail Displays the Notify Me link on the answer details page.

AnswerNoticationManager account/notif/list Opens the list of answers to which a customer is subscribed and
displays the Renew and Delete buons.

account/prole

public_prole

public_prole_update

mobile/account/prole

AvatarDisplay

mobile/public_prole

Displays a community user’s avatar.

BasicAnswerFeedback basic/answers/detail Displays the Was This Answer Helpful? section of the page,
 including the Yes/No buons, and the Submit Feedback buon.

basic/ask Displays input elds for incident custom elds.

basic/account/prole Displays input elds for contact custom elds.

BasicCustomAllInput

basic/utils/create_account Displays input elds for contact custom elds.

basic/account/questions/listBasicDisplaySearchFilters

basic/answers/list

Displays the search lters that were used to restrict a search by
products, categories, or both.

BasicEmailCredentials basic/utils/account_assistance Displays the elds and buons for customers to enter their email
address or user name and request to have their user name emailed
to them or have their password reset.

basic/ask Displays the Email Address, Subject, and Question elds.

basic/account/change_password Displays the Current Password, Password, and Verify Password
elds.

BasicFormInput

basic/account/prole Displays the Username, First Name, Last Name, Email Address,
 Street, City, Country, State/Province, Postal Code, and phone
number elds.
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Widget Page Widget functionality on the page

basic/account/questions/detail Displays the eld for adding information to a question being
updated and the Do You Want a Response? eld and menu.

basic/answers/submit_feedback Displays the Email Address and Feedback elds for submiing
feedback on an answer.

basic/utils/create_account Displays the Email Address, Username, Password, Verify Password,
 First Name, and Last Name elds.

basic/ask

basic/account/change_password

basic/utils/create_account

basic/account/prole

basic/account/reset_password

basic/account/setup_password

basic/account/questions/detail

basic/answers/detail

basic/answers/submit_feedback

BasicFormStatusDisplay

basic/utils/account_assistance

Displays status and error messages from form submissions on the
basic page set.

basic/ask

basic/account/change_password

basic/account/prole

basic/account/questions/detail

basic/answers/submit_feedback

Displays the Submit buon.BasicFormSubmit

basic/utils/create_account Displays the Create Account buon.

basic/home

basic/account/questions/list

BasicKeywordSearch

basic/answers/list

Displays the Search eld.

BasicLoginForm basic/utils/login_form Displays the Username and Password elds and the Log In buon.

BasicLogoutLink templates/basic Displays the link to log users out.

basic/account/overview Displays the customer’s incidents in the Questions section.BasicMultiline

basic/account/questions/list Displays the customer’s incidents, ltered by product or category if
selected.
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basic/answers/list Displays the list of answers that meet customer-entered search
terms.

basic/account/questions/listBasicPaginator

basic/answers/list

Displays a list of page numbers that customers can select when
the length of a report exceeds what can be displayed on a single
page.

BasicProductCategoryInput basic/ask Lets customers select a product and category when they submit a
question.

basic/account/questions/listBasicProductCategorySearchFilter

basic/answers/list

Displays the Limit by Product and Limit by Category search lters.

basic/reset_passwordBasicResetPassword

basic/account/setup_password

Displays the Password and Verify Password elds and the Submit
buon. This widget is accessed only through a link in an email sent
to the customer.

basic/account/questions/listBasicResultInfo

basic/answers/list

Displays the number of matching answers displayed in the search
results.

social/questions/detailBestAnswerDisplay

mobile/social/questions/detail

Displays the best answers selected by the original author and a
community moderator.

BrowserSearchPlugin templates/standard Provides a link that can be output to a browser search engine plug-
in.

chat/chat_landingChatAgentStatus

mobile/chataccount/chat_landing

Displays the status of the chat agent (absent, listening, or
responding).

ChatAachFileBuon chat/chat_landing Displays the Aach File buon.

chat/chat_landingChatCancelBuon

mobile/chat/chat_landing

Displays the Leave buon.

chat/chat_landingChatDisconnectBuon

mobile/chat/chat_landing

Displays the Disconnect buon.

chat/chat_landingChatEngagementStatus

mobile/chat/chat_landing

Displays the status of the chat session.

chat/chat_launchChatHours

mobile/chat/chat_launch

Lists the chat hours dened on the administration interface and
the current date and time.

chat/chat_launchChatLaunchBuon

mobile/chat/chat_launch

Displays the Submit Request buon.

ChatOTheRecordBuon chat/chat_landing Displays the Chat O the Record buon.
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mobile/chat/chat_landing

chat/chat_landingChatOTheRecordDialog

mobile/chat/chat_landing

Opens the dialog for sending an o-the-record message when the
Chat O the Record buon is clicked.

chat/chat_landingChatPostMessage

mobile/chat/chat_landing

Displays the area where customers enter chat messages.

chat/chat_landingChatPrintBuon

mobile/chat/chat_landing

Displays the Print buon for printing the chat transcript.

chat/chat_landingChatQueueSearch

mobile/chat/chat_landing

Adds a Search buon and eld where customers can search for an
answer while waiting for a chat session.

chat/chat_landingChatQueueWaitTime

mobile/chat/chat_landing

Displays a message to let customers know their position in the
chat session queue, the estimated wait time, the average wait time,
 or all three.

chat/chat_landingChatRequestEmailResponseBuon

mobile/chat/chat_landing

Displays the Request Email Response buon that appears when no
agents are available.

chat/chat_landingChatSendBuon

mobile/chat/chat_landing

Displays the Send buon that submits customer chat messages.

chat/chat_landingChatServerConnect

mobile/chat/chat_landing

Displays the message customers see while the chat connection is
being established and when other events occur during the chat
session.

chat/chat_landingChatSoundBuon

mobile/chat/chat_landing

Produces an audible signal to indicate when customers are
connected to an agent and when agents post a response.
Customers can turn the audio on or o.

chat/chat_launchChatStatus

mobile/chat/chat_launch

Displays a message to let customers know if chat sessions are
currently available.

chat/chat_landingChatTranscript

mobile/chat/chat_landing

Contains a record of the customer and agent messages that
comprise the chat session.

answers/detail

answers/list

results

social/questions/detail

ContactUs

social/questions/list

Displays options for contact, including asking a question to
support sta and community, chaing with an agent, and
providing site feedback.
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account/questions/detail

basic/account/questions/detail

CustomAllDisplay

mobile/account/questions/detail

Displays the read-only incident custom elds in the Additional
Details section.

chat/chat_launch

mobile/chat/chat_launch

Displays input elds for incident custom elds with chat visibility.

utils/create_account

CustomAllInput

mobile/utils/create_account

Displays input elds for contact custom elds.

account/questions/detail Displays these read-only incident elds: incident thread,
customer’s email address, reference number for the incident,
incident status, the dates the incident was created and last
updated, the product and category associated with the incident,
and le aachments.

answers/detail Displays an answer’s le aachments with links to the les.

basic/account/questions/detail Displays these read-only incident elds: incident thread,
customer’s email address, reference number for the incident,
incident status, the dates the incident was created and last
updated, the product and category associated with the incident,
and le aachments.

basic/answers/detail Displays an answer’s le aachments with links to the les.

mobile/account/questions/detail Displays these read-only incident elds: incident thread,
customer’s email address, reference number for the incident,
incident status, the dates the incident was created and last
updated, the product and category associated with the incident,
and le aachments.

DataDisplay

mobile/answers/detail Displays an answer’s le aachments with links to the les.

social/askDiscussionAuthorSubscription

mobile/social/ask

Allows authors of questions to subscribe to be notied by email
when comments are posted to their questions.

products/detailDiscussionSubscriptionIcon

social/questions/detail

Allows community users to subscribe or unsubscribe to products
or categories and social discussions.

DiscussionSubscriptionManager account/notif/list Displays discussions a community user is subscribed to.

account/prole

public_prole_update

utils/create_account

mobile/account/prole

DisplayNameInput

mobile/utils/create_account

Displays the eld for entering a community user’s display name.
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DisplaySearchSourceFilters social/questions/list Displays the search lters applied to the search results.

answers/detailEmailAnswerLink

social/questions/detail

Displays the Email This Page link.

mobile/utils/account_assistanceEmailCredentials

utils/account_assistance

Displays the elds and buons for customers to enter their email
address or user name and request to have their user name emailed
to them or have their password reset.

account/questions/detail Displays the eld and Browse buon for aaching additional
documents to a question being updated.

ask Displays the eld and Browse buon for aaching documents to a
question being asked.

mobile/account/questions/detail Displays the eld and Browse buon for aaching additional
documents to a question being updated.

FileAachmentUpload

mobile/ask Displays the eld and Browse buon for aaching documents to a
question being asked.

account/prole Displays the user name, email address, street, city, country, state,
 postal code, and phone number elds.

account/questions/detail Displays the eld for adding information to a question being
updated and the Do You Want a Response? eld and menu.

ask Displays the Email Address, Subject, and Question elds.

chat/chat_launch Displays the Email Address eld.

mobile/account/prole Displays the user name, email address, street, city, country, state,
 postal code, and phone number elds.

mobile/account/questions/detail Displays the eld for adding information to a question being
updated and the Do You Want a Response? eld and menu.

mobile/ask Displays the Email Address, Subject, and Question elds.

mobile/chat/chat_launch Displays the Email Address eld.

mobile/social/ask Displays the Email Address, Subject, and Question elds.

mobile/utils/create_account Displays the Email Address, Username, Password, and Verify
Password elds.

social/ask Displays the Email Address, Subject, and Question elds.

FormInput

utils/create_account Displays the Email Address, Username, Password, and Verify
Password elds.

account/change_password Displays the Submit buon.

account/prole Displays the Save Changes buon.

FormSubmit

account/prole_picture Displays the Save Changes buon.
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account/questions/detail Displays the Submit buon.

ask Displays the Continue buon.

mobile/account/change_password Displays the Submit buon.

mobile/account/prole Displays the Save Changes buon.

mobile/account/prole_picture Displays the Save Changes buon.

mobile/account/questions/detail Displays the Submit buon.

mobile/ask Displays the Continue buon.

mobile/social/ask Displays the Post Your Question buon.

mobile/utils/create_account Displays the Create Account buon.

public_prole_update Displays the Save Changes buon.

social/ask Displays the Post Your Question buon.

utils/create_account Displays the Create Account buon.

account/overview Displays reports of recently submied questions, recent answer
notications, and service contracts.

Grid

account/questions/list Displays the Support History report.

agent/guided_assistant Opens a preview of the guide on the administration interface.

answers/detail Opens the rst question of the guide associated with the answer.

mobile/answers/detail Displays the Launch the Troubleshooter buon.

GuidedAssistant

mobile/utils/guided_assistant Opens the rst question of the guide associated with the answer.

account/questions/list

answers/list

mobile/account/questions/list

KeywordText

mobile/answers/list

Displays the search eld.

mobile/utils/login_formLoginForm

utils/login_form

Displays the Username and Password elds and the Log In buon.

mobile/account/questions/list Displays the list of customer’s incidents.MobileMultiline

mobile/answers/list Opens a list of answers when See All Popular Answers is clicked on
the Home page.

MobileProductCategoryInput mobile/ask Displays the Select a Product or Select a Category buon and the
associated menus.
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mobile/social/ask

MobileProductCategoryList basic/home Displays the list of Featured Support Categories.

mobile/account/questions/listMobileProductCategorySearchFilter

mobile/answers/list

Displays the product and category search lters.

MobileSourceProductCategorySearchFiltersocial/questions/list Displays the search lters applied to the search results.

social/moderate/comment

social/moderate/question

ModerationAction

social/moderate/user

Displays the actions allowed on the moderation report based on
the permissions assigned to the moderator.

social/moderate/comment

social/moderate/question

ModerationFilterBreadcrumbs

moderate/user

Displays the lters that have been applied to the moderation
report.

social/moderate/comment

social/moderate/question

ModerationFilterDialog

social/moderate/user

Displays the available moderation lters options of updated date,
 status, and product or category.

social/moderate/comment

social/moderate/question

ModerationGrid

social/moderate/user

Displays moderation data in a grid.

mobile/public_proleModerationInlineAction

public_prole

Displays a drop-down menu of moderation actions available for
performing inline moderation.

ModerationProle public_prole Allows moderators to view user name and email information on
the Public Prole page.

ModerationSummaryTable social/moderate/overview Displays the report of suspended, active, archived, and total
questions, comments, and users on the Moderation Overview
page.

Multiline answers/list Displays the list of answers that meet customer-entered search
terms.

templates/standardNavigationTab

templates/mobile

Displays the Support Home and Ask a Question navigation tabs.

mobile/utils/create_accountOpenLogin

mobile/utils/login_form

Displays the third-party sites that can authenticate customers,
allowing them to be logged in to the customer portal. The default
providers include Facebook, Twier, Google, Yahoo, and any valid
OpenID provider.
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Widget Page Widget functionality on the page

utils/create_account

utils/login_form

chat/chat_landing

mobile/chat/chat_landing

templates/standard

OracleLogo

templates/mobile

Displays the Oracle logo.

templates/basic

templates/mobile

PageSetSelector

templates/standard

Displays the option for selecting the desktop, mobile, or basic page
set.

account/questions/list

answers/list

mobile/account/questions/list

mobile/answers/list

social/moderate/comment

social/moderate/question

Paginator

social/moderate/user

Displays a list of page numbers that customers can select when
the length of a report exceeds what can be displayed on a single
page.

account/change_passwordPasswordInput

mobile/account/change_password

Displays the Current Password, Password, and Verify Password
elds.

account/questions/detail

answers/detail

public_prole

PrintPageLink

social/questions/detail

Displays the Print link.

ProdCatNoticationManager account/notif/list Opens the list of products and categories to which a customer is
subscribed and displays the Renew, Delete, and Add Notications
buons.

answers/detail

products/detail

social/questions/detail

ProductCategoryBreadcrumb

mobile/answers/detail

Displays a breadcrumb of product or category links that indicates
the hierarchy of the selected product or category.
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mobile/products/detail

mobile/social/questions/detail

products/detailProductCategoryImageDisplay

mobile/products/detail

Displays an image of a product or category.

askProductCategoryInput

social/ask

Displays the drop-down menus of products and categories that
can be selected when submiing a question.

ProductCategoryList templates/standard Displays a hierarchical list of products in the template footer.

account/questions/listProductCategorySearchFilter

answers/list

Allows product or category lter selection when searching on the
Answers List or Questions List page.

social/questions/detailQuestionComments

mobile/social/questions/detail

Displays a comment form for users to post responses to questions
or other comments.

social/questions/detailQuestionDetail

mobile/social/questions/detail

Displays a question eld with title and body and lets the question’s
author make edits.

social/questions/detailQuestionStatus

mobile/social/questions/detail

Displays the status of a question if it is anything other than active
and not locked.

home

products/detail

mobile/home

RecentlyAnsweredQuestions

mobile/products/detail

Displays a list of recent discussions that have best answers
associated with them.

answers/detail

answers/list

results

social/questions/detail

RecentlyViewedContent

social/questions/list

Displays recently viewed answers and discussions in the sidebar.

answers/detailRelatedAnswers

basic/answers/detail

Displays the Answers Others Found Helpful heading with links to
related answers.

RelatedKnowledgebaseAnswers social/questions/detail Displays ocial (knowledgebase) answers related to the discussion
being viewed.

1184



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

Widget Page Widget functionality on the page

account/reset_password

account/setup_password

mobile/account/reset_password

ResetPassword

mobile/account/setup_password

Displays the Password and Verify Password elds and the Submit
buon. This widget is accessed only through a link in an email sent
to the customer.

account/notif/list

account/questions/list

answers/list

social/moderate/comment

social/moderate/question

social/moderate/user

mobile/account/questions/list

ResultInfo

mobile/answers/list

Displays the number of matching answers displayed in the search
results.

RichTextInput social/ask Allows basic HTML markdown in the Question eld when
submiing a question to the community.

answers/listRssIcon

products/detail

Displays the RSS icon that links to the feed of your site’s public
answers or social questions.

account/questions/list

answers/list

mobile/account/questions/list

SearchBuon

mobile/answers/list

Displays the Search icon.

public_prole

templates/standard

SimpleSearch

templates/mobile

Displays the Search eld on all pages except Support Home and
the Search Results pages.

ask

social/ask

mobile/ask

SmartAssistantDialog

mobile/social/ask

Displays a list of suggested answers when customers submit a
question to support sta or the community.

answers/detailSocialBookmarkLink

social/questions/detail

Displays the Share link that opens a menu of social networking
sites.
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Widget Page Widget functionality on the page

results

social/questions/list

mobile/results

SocialResultListing

mobile/social/questions/list

Displays a list of results returned from searching community
content.

account/prole_pictureSocialUserAvatar

mobile/account/prole_picture

Allows community users to select their avatar by using an
automatically generated one or selecting their Gravatar picture.

social/questions/listSourceFilter

mobile/social/questions/list

Displays the Filter By Age and Filter By Best Answer lters.

answers/listSummaryResultListing

social/questions/list

Displays a list of published answer titles on the Questions List
page or a list of discussion titles on the Answers List page.

TextInput mobile/social/ask Used to enter the body of a question posed to the community.

home.php

basic/home.php

mobile/home.php

products/detail

TopAnswers

mobile/products/detail

Displays a list of suggested top answers that can be ltered by
product or category.

Unsubscribe account/notif/unsubscribe Lists the notications a customer is subscribed to. This widget is
accessed only through a link in an email sent to the customer.

public_proleUserActivity

mobile/public_prole

Displays a community user’s activity within the community.

public_proleUserContributions

mobile/public_prole

Displays a summary of totals of a community user’s questions,
 comments, and best answers.

social/askUserInfoDialog

mobile/social/ask

Displays a request for a customer to submit a display name in
order to participate in the community.

public_proleUserStatus

mobile/public_prole

Displays a community user’s status if the status is anything other
than active.

chat/chat_landingVirtualAssistantAvatar

mobile/chat/chat_landing

Displays the virtual assistant avatar during the chat engagement.

VirtualAssistantBanner chat/chat_landing Displays the virtual assistant banner during the chat engagement.
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Widget Page Widget functionality on the page

mobile/chat/chat_landing

chat/chat_landingVirtualAssistantFeedback

mobile/chat/chat_landing

Displays the Was This Response Helpful? section of the page,
 including the Yes/No buons, and the Submit Feedback buon
during the chat engagement.

chat/chat_landingVirtualAssistantSimilarMatches

mobile/chat/chat_landing

Displays links to content that is similar to the phrases used in the
chat engagement.

home

products/detail

mobile/home

VisualProductCategorySelector

mobile/products/detail

Displays images of products or categories that serve as links for
drilling down into subproducts or subcategories.

Widgets Not Used in Reference Implementation  
A number of widgets are available for you to use in your Customer Portal site.

These standard widgets are not used in the reference implementation but are available for you to add to your pages.

• chat

◦ ChatCoBrowseBuon (used in prior Customer Portal frameworks)

◦ ChatCobrowsePremium

◦ ChatLaunchFormOpen (used in prior Customer Portal frameworks)

◦ ProactiveChat

◦ ConditionalChatLink (used in the ContactUs widget)

• discussion

◦ RecentlyAskedQuestions

• feedback

◦ SiteFeedback (used in ContactUs widget)

◦ SocialContentFlagging (used in QuestionComments and QuestionDetail widgets)

◦ SocialContentRating (used in QuestionComments and QuestionDetail widgets)

• input

◦ AssetCheck

◦ ChannelAllInput

◦ ContactNameInput (used in prior Customer Portal frameworks)

◦ DateInput (used in FormInput widget)

◦ EmailCheck
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◦ ProductCatalogInput

◦ SelectionInput (used in FormInput widget)

• knowledgebase

◦ SearchSuggestions

◦ TopicBrowse

◦ TopicWords

• login

◦ LoginDialog (used in AccountDropdown and AnswerNoticationIcon widgets)

◦ LogoutLink (used in AccountDropdown widget)

• moderation (These widgets are all used in the ModerationFilterDialog widget)

◦ ModerationContentFlagFilter

◦ ModerationDateFilter

◦ ModerationStatusFilter

• navigation

◦ Accordion

◦ MobileNavigationMenu

• output

◦ ChannelAllDisplay

◦ FieldDisplay (used in other input widgets)

◦ FileListDisplay (used in /views/admin/answer_full_preview.php for displaying the print version of an
answer on the agent desktop)

◦ IncidentThreadDisplay (used in the DataDisplay widget)

◦ ProductCatalogDisplay

◦ ProductCategoryDisplay (used in the ProductCategoryInput and DataDisplay widgets)

• search

◦ AdvancedSearchDialog

◦ AssetOrgList

◦ CombinedSearchResults

◦ DisplaySearchFilters

◦ FilterDropdown

◦ OrgList

◦ ProductCatalogSearchFilter

◦ SearchTypeList (contained in AdvancedSearchDialog, which is no longer in use on the reference
implementation)
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Note:  You should add the SearchTypeList widget to any page containing a custom report that
uses an integer lter. Without the widget, your customers can search only by answer ID. Adding
the widget lets your customers select a dierent search type so they can enter text search terms.

◦ SortList (contained in AdvancedSearchDialog)

◦ WebSearchSort (contained in AdvancedSearchDialog)

◦ WebSearchType (contained in AdvancedSearchDialog)

• searchsource

◦ SourceSort

• social

◦ AnswerComments

◦ CommunityPosts

◦ CommunityPostSubmit

◦ CommunitySearchResults

◦ CommunityUserDisplay

• surveys

◦ SurveyLink

◦ ProactiveSurveyLink

• utils

◦ Blank

◦ CoBrowseLink

◦ CoBrowsePremium

◦ ProgressBar

Set the Maximum Year for Date Drop-Down Menus  
You can set date drop-down menu values.

By default, drop-down date menus display the current year as the highest year option.
1. Locate EU_MAX_YEAR in Common/Knowledge Base/Answer Search.
2. Set the maximum year.

a. To set the maximum value to the current year, clear any existing value so the Value eld is blank.
b. To set a specic year, enter that year in the Value eld.
c. To set an oset (for example, ve years from this year), enter the oset value in the Value eld. In this

example, type +5.
3. Click Save.

Add an Incident Date Field  
This example demonstrates adding a custom eld, on the Ask a Question page, leing customers tell you how quickly
they need an answer to their submied question.

1. Open Custom Fields in  Conguration > Database .
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2. Click Incident.
3. Click New.
4. In the Name eld, enter Answer Needed By.
5. Click Data Type and select Date Field.
6. In the Column Name eld, enter answer_needed.

Note:  The Column Name cannot contain spaces.

7. To require customers to complete the eld, select Required for Customer Portal.
8. If the Visibility check boxes for End-user Display and Edit are not selected, select both of them.
9. Click Save.

Determine Unused Widgets  
You can view a list of obsolete custom widgets.

1. On the Customer Portal Administration page, select Widgets.
2. Select Widgets Not In Use.

Depending on the size of your site, this review can take some time.
3. If the widgets are not actively being worked on, you can remove them from your live site and archive them.

Logging in to the Customer Portal  

How Customers Log in to the Customer Portal  
Your customers can log in directly or they can log in through an external site that veries their identity.

These are the various login methods.

• Standard login—Customers use standard login when they log in to your customer portal using the user name
and password assigned to them in Oracle Service Cloud instead of logging in through an external service
provider, such as Facebook or PingFederate. Clicking the Log In or Sign Up buon (the AccountDropdown
widget) in the upper right corner of any customer portal page opens the login window that lets customers log
in. Customers who do not yet have an account can click the Create an Account buon on the login window to
open a form for entering contact information.

• Open login—Customers can log in to the customer portal through an external service provider where they
already have an account. You can accept veried customer logins from Facebook, Twier, Google, and Yahoo,
and any other open login provider you want to add.

• Pass-through authentication (PTA)—You can integrate the customer portal with your organization’s website
so your customers can automatically log in to your support site. Although your organization’s web pages may
be external to the customer portal, they can pass login parameters through the URL of the customer portal
page. As a result, your customers do not have to complete a second login procedure to access your support
site. Information sharing between your external site and the customer portal can be used to create and update
contact records. To enable pass-through authentication, contact your Oracle account manager.

◦ Encrypted pass-through authentication—Data encryption transmits customer information even more
securely through the customer portal page URL using one of several encryption options. You can
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congure encrypted PTA so your customers can log in directly to the customer portal as well as log
in with pass-through authentication from your external site. You also have the option of requiring
customers to log out through the external site or allowing them to log out from the customer portal. Your
Oracle account manager can provide information about encrypted PTA.

• SAML 2.0 open login (single sign-on)—Instead of logging in to the customer portal with their Oracle Service
Cloud user name and password, customers can log in to a third-party identity provider, such as PingFederate or
Windows ADFS, which authenticates their identity. Then they select a connection to the customer portal. The
identity provider veries their login, sends an assertion to the customer portal, which veries the signature and
(if successful) logs the customer in.

Related Topics
• Accessing PTA Guides

Remove the Password Field Using the Conguration Seing  
You can turn o the password requirement.

If you remove the Password eld using this procedure, customers who already have passwords will still be able to log in
with only their user name.

1. Locate EU_CUST_PASSWD_ENABLED under RightNow User Interface/General.
2. Click the Value drop-down menu and set the value to No.
3. Click Save.

Remove the Password Field by Editing Code  
You can remove the password requirement from your Customer Portal pages.

If you remove the Password eld using this procedure, you will override the value of the EU_CUST_PASSWD_ENABLED
conguration seing. Customers who do not have a value in the password eld in the database will still be able to log in
with only their user name, but customers who have a value in the password eld in the database will not be able to log
in.

1. Open one of the following les:
◦ /views/templates/standard.php

◦ /views/templates/mobile.php
2. Locate this text, which should be in the last lines of code for the rst AccountDropdown widget.

sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" />

3. Add the disable_password attribute to the widget and set the value to true.
The last line of code will be:
disable_password="true"/>

4. Save the le.

Change the Password Reference on the Login Page  
You can use this process to remove the password label.
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Removing the Password eld does not automatically change the message bases within the customer portal.
1. Open one of these les:

◦ /views/templates/standard.php

◦ /views/templates/mobile.php
2. Locate sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" />, which should be in the last

lines of code for the rst AccountDropdown widget.
3. Add the label_assistance aribute to the widget and set the value to the new message.

label_assistance="Forgot your username?"/>

4. Save the le.

Remove the Password Link on the Account Overview Page  
This example removes the password reference from the Account Overview page.

1. Open /views/pages/account/overview.php .
2. Delete this code.

<li><a href="/app/account/change_password#rn:session#">
 #rn:msg:CHANGE_YOUR_PASSWORD_CMD#</a></li>

3. Save the le.

Remove the Password Link on the Account Seings Page  
This process removes password references from the Account Seings page.

If you removed the password by seing the EU_CUST_PASSWD_ENABLED conguration seing to No, this procedure
is unnecessary because the page code checks the seing and removes the password link automatically. If you disabled
the password by adding the disable_password aribute to the AccountDropdown widget on the template, you should
perform this procedure.

1. Open one of the Prole page les:
◦ /views/pages/account/prole.php

◦ /views/pages/mobile/account/prole.php
2. Delete this code.

<rn:condition external_login_used="false">
 <rn:condition config_check="RNW_UI:EU_CUST_PASSWD_ENABLED == true">
 <br>
 <a href="/app/#rn:config:CP_CHANGE_PASSWORD_URL##rn:session#">#rn:msg:CHANGE_YOUR_PASSWORD_CMD#</a>
 </rn:condition>
</rn:condition>

3. Save the le.

Edit Message Bases on the Login Window  
Use this process to edit read-only messages set in the system message bases.

1. Open one of these template les:
◦ /views/templates/standard.php

1192



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

◦ /views/templates/mobile.php

2. To edit the “Please log in to continue” heading, add the label_dialog_title aribute to the rst instance of the
AccountDropdown widget and set the value to the new message.
label_dialog_title="Log in to access product information"/>

3. To edit the “Quickly log in or create an account…” message, add the label_open_login aribute to the rst
AccountDropdown widget and set the value to the new message.
label_open_login_intro="Speed up your login by using one of these accounts"/>

4. To edit the “Create an Account” message on the buon, add the label_create_account_buon aribute to the
rst AccountDropdown widget and set the value to the new message.

5. To edit the “Forgot your username or password?” message, add the label_assistance aribute to the rst
AccountDropdown widget and set the value to the new message.

6. To edit any other label on the page, nd its corresponding aribute on the widget information page for the
LoginDialog widget, add the aribute to the AccountDropdown widget, and set its value to the new message.

7. Save the le.

Edit the Create an Account Form  
You cannot add or remove elds on the Create an Account form, but you can change their labels and whether the eld is
required.

1. Open one of the template les:

◦ /views/templates/standard.php

◦ /views/templates/mobile.php

2. To edit any of the eld labels, edit the label aribute of the associated eld on the rst instance of the
AccountDropdown widget and set the value to the new message.
sub:input_Contact.Login:label_input="Account Name"

3. To not require an email address or rst name, remove the line of code from the rst AccountDropdown widget
that contains the required aribute.
sub:input_Contact.Name.First:required="true"

Note:  If you do not require a user name, the customer will see a message that they do not have
permission to create a user, so you should not remove the requirement for that eld. The Display
Name and Last Name elds are required by default. Even if you remove the requirement for the last
name or add the required aribute to the display name code and set it to false, those elds will still be
required.

4. Save the le.

Edit the Password Label on the Create an Account Form  
You can edit the label on the Create an Account form.

If you set a minimum password length that customers must enter, passwords are automatically required.
1. Open /views/templates/standard.php.
2. Locate sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" in the rst AccountDropdown

widget.
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3. Edit the label_input aribute to dene password length information.
sub:input_Contact.NewPassword:label_input="Password (8 characters minimum)"

4. Save the le.

Edit the Create an Account Page  
You can edit the Create an Account page to meet the needs of your organization.

1. Open one of the following les:

◦ /views/pages/utils/create_account.php

◦ /views/pages/mobile/utils/create_account.php

2. To add a global opt-in eld on the Create an Account page, follow these steps.
a. Locate the following line of code.

<rn:widget path="input/CustomAllInput" table="Contact"/>

b. Add a FormInput widget after the line you located in step A to ask customers if they want to be on your
mailing list.
The following sample code adds the widget and also changes the label from the default value of Global
Opt-In.
<rn:widget path="input/FormInput" name="Contact.MarketingSettings.MarketingOptIn"
 label_input="Can we add you to our mailing list?" />

3. To enable an email conrmation loop, modify the CP.EmailConfirmationLoop.Enable seing.
a. Open the cp/customer/development/cong/siteCong.json le.
b. Set the CP.EmailConfirmationLoop.Enable to 1.

4. Save the le.

Add Fields on the Create an Account Page  
You might want to add alternate email address elds and the customer’s mailing address to the page.

1. Open one of these les:

◦ /views/pages/utils/create_account.php

◦ /views/pages/mobile/utils/create_account.php

2. To add a contact eld, add a line of code that calls the FormInput widget.

To nd the names of all the contact elds you can use for the FormInput widget, click  Framework > Business
Objects  on the Customer Portal Administration site.

<rn:widget path="input/FormInput" name="Contact.Emails.ALT1.Address"
 label_input="Alternate Email 1" />
<rn:widget path="input/FormInput" name="Contact.Emails.ALT2.Address"
 label_input="Alternate Email 2" />
<rn:widget path="input/FormInput" name="Contact.Address.Street" />
<rn:widget path="input/FormInput" name="Contact.Address.City" />
<rn:widget path="input/FormInput" name="Contact.Address.StateOrProvince"
 label_input="State or Province" />
<rn:widget path="input/FormInput" name="Contact.Address.PostalCode" />

3. To allow the entry and display of multiple lines in the Street eld, add the textarea aribute to the FormInput
widget.
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<rn:widget path="input/FormInput" name="Contact.Address.Street" textarea="true" />

4. To add an organization login and password so your customers can be associated with an organization, add this
code.
<rn:widget path="input/FormInput" name="Contact.Organization.Login"
 label_input="Organization Login" />
<rn:widget path="input/FormInput" name="Contact.Organization.NewPassword"
 label_input="Organization Password" />

5. To make the organization login and password required elds, replace the code in the previous step with this
code.
<rn:widget path="input/FormInput" name="Contact.Organization.Login"
 required="true" label_input="Organization Login" />
<rn:widget path="input/FormInput" name="Contact.Organization.NewPassword"
 required="true" label_input="Organization Password" />

6. Save the le.

Remove Fields on the Create an Account Page  
Removing the associated widget will remove the eld from the page.

1. Open one of the following les:

◦ /views/pages/utils/create_account.php

◦ /views/pages/mobile/utils/create_account.php

2. To remove the Email Address eld, delete the following line of code.
<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
 validate_on_blur="true" initial_focus="true" label_input="#rn:msg:EMAIL_ADDR_LBL#"/>

3. To remove the Username eld, delete the following line of code.
<rn:widget path="input/FormInput" name="Contact.Login" required="true" validate_on_blur="true"
 label_input="#rn:msg:USERNAME_LBL#" hint="#rn:msg:TH_PRIVATE_S_LOG_IN_SITE_JUST_WANT_MSG#"/>

4. To remove the Display Name eld, delete the following line of code.
<rn:widget path="input/DisplayNameInput" label_input="#rn:msg:DISPLAY_NAME_LBL#"
 hint="#rn:msg:TH_PUBLIC_THATS_DISP_ALONG_COMMENTS_MSG#"/>

5. To remove the Password and Verify Password elds, delete the following lines of code.
<rn:condition config_check="EU_CUST_PASSWD_ENABLED == true">
 <rn:widget path="input/FormInput" name="Contact.NewPassword" require_validation="true"
 label_input="#rn:msg:PASSWORD_LBL#" label_validation="#rn:msg:VERIFY_PASSWD_LBL#"/>
</rn:condition>

6. To remove the First Name and Last Name elds, delete the following lines of code.
<rn:condition config_check="intl_nameorder == 1">
 <rn:widget path="input/FormInput" name="Contact.Name.Last"
 label_input="#rn:msg:LAST_NAME_LBL#" required="true"/>
 <rn:widget path="input/FormInput" name="Contact.Name.First"
 label_input="#rn:msg:FIRST_NAME_LBL#" required="true"/>
 <rn:condition_else/>
 <rn:widget path="input/FormInput" name="Contact.Name.First"
 label_input="#rn:msg:FIRST_NAME_LBL#" required="true"/>
 <rn:widget path="input/FormInput" name="Contact.Name.Last"
 label_input="#rn:msg:LAST_NAME_LBL#" required="true"/>
</rn:condition>

7. To remove all contact custom elds with end-user visibility, delete the following line of code.
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<rn:widget path="input/CustomAllInput" table="Contact"/>

8. Save the le.

Edit the Password Label on the Create an Account Page  
You can edit the password label on the Create an Account page.

1. Open one of the Create an Account page les:
◦ /views/pages/utils/create_account.php

◦ /views/pages/mobile/utils/create_account.php
2. Locate <rn:widget path="input/FormInput" name="Contact.NewPassword" require_validation="true"

label_input="#rn:msg:PASSWORD_LBL#" label_validation="#rn:msg:VERIFY_PASSWD_LBL#"/>.
3. Edit the label_input aribute of the FormInput widget to dene password length information.

<rn:widget path="input/FormInput" name="Contact.NewPassword" require_validation="true"
 label_input="Password (8 characters minimum)" label_validation="#rn:msg:VERIFY_PASSWD_LBL#"/>

4. Save the le.

Edit the Password Label on the Change Your Password Page  
You can edit the label on the Change Your Password page.

1. Open one of the change password les:
◦ /views/pages/account/change_password.php

◦ /views/pages/mobile/account/change_password.php
2. Locate <rn:widget path="input/PasswordInput" name="Contact.NewPassword"

require_validation="true" require_current_password="true" label_input="#rn:msg:PASSWORD_LBL#"

label_validation="#rn:msg:VERIFY_PASSWD_LBL#" initial_focus="true"/>.
3. Edit the label_input aribute of the PasswordInput widget to dene password length information.

<rn:widget path="input/PasswordInput" name="Contact.NewPassword" require_validation="true"
 require_current_password="true" label_input="Password (8 characters minimum)"
 label_validation="#rn:msg:VERIFY_PASSWD_LBL#" initial_focus="true"/>

Note:  Even if you leave the required aribute set to false, seing a minimum password length on the
administration interface causes the conguration seing to override the aribute.

4. Save the le.

Prevent User Name Enumeration  
This process adds barriers to the Create an Account page, preventing the automated harvesting of user names.

User name enumeration is an automated aempt to retrieve user names in your database for malicious purposes.
1. Open /views/pages/utils/create_account.php.
2. Locate these lines of code.

<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
 validate_on_blur="true"
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 initial_focus="true" label_input="#rn:msg:EMAIL_ADDR_LBL#"/>
 <rn:widget path="input/FormInput" name="Contact.Login" required="true"
 validate_on_blur="true" 
 label_input="#rn:msg:USERNAME_LBL#"hint="#rn:msg:TH_PRIVATE_S_LOG_IN_SITE_JUST_WANT_MSG#"/>

3. Remove the validate_on_blur aribute for both widgets.
4. Locate this line of code.

<rn:widget path="input/FormSubmit" label_button="#rn:msg:CREATE_ACCT_CMD#"
 on_success_url="/app/account/overview" error_location="rn_ErrorLocation"/>

5. Edit the code for the Create Account buon (the FormSubmit widget) to add the challenge_required aribute.
<rn:widget path="input/FormSubmit" label_button="#rn:msg:CREATE_ACCT_CMD#"
 on_success_url="/app/account/overview" error_location="rn_ErrorLocation"
 challenge_required="true" />

6. Save the le.

Overview of Open Login  
Open login lets your customers log in to the customer portal by logging in through an external service provider where
they already have an account.

By using an external service to authenticate customers instead of requiring them to create a separate customer
portal account, you oer your customers a faster, more convenient experience. The default login and Create an
Account form contain four OpenLogin widgets, each associated with an external service provider: Facebook, Twier,
Google, and Yahoo. When customers click the Create an Account buon, the form opens. Instead of completing the
contact information elds on the page to create their account, they can click a widget associated with an external
provider where they already have an account. After logging in to the external account, an account is created for them
automatically in Oracle Service Cloud.

Note:  If you are opening your customer portal pages in iFrames, you should not use open login. Open login
directs customers to a third-party site that then redirects them to the customer portal after verication.
Because iFrames do not display a URL, customers cannot verify that the third-party login site is legitimate,
and security issues are possible. Additionally, some open login providers do not allow their login page to be
opened in an iFrame.

Customers who click the Facebook, Twier, Google, or Yahoo OpenLogin widgets see a message that tells them to log
in to the external service and explains that they will then be redirected to your customer portal and logged in. When
they click the buon above the message, they are taken to the external site to log in (if they are not already logged
in). The site asks for permission to send their email address and possibly their name, depending on the site, back to
the customer portal. Customers who allow the transfer of information to Oracle Service Cloud are redirected to the
customer portal and logged in automatically.

How Open Login Works  
The Customer Portal uses the web industry protocols OAuth and OpenID to let customers log in from their existing
accounts on external services.

To allow customers to log in using Facebook, Twier, and Google, you must dene public IDs and private keys for
the applications. Additionally, to use Facebook as an open login provider, you must migrate to OAuth 2.0, process a
signed_request parameter, and obtain an SSL certicate. The Customer Portal supports OAuth 1.0 – 2.0.
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OAuth lets customers grant authorization for your customer portal to access their information from external sites where
they have existing accounts.

OpenID lets customers log in to the site, which then conrms their identity to your customer portal, and also lets them
specify what customer information can be shared.

Note:  Customer information includes, at a minimum, an email address, but may contain other information,
such as the customer’s full name. The specic information that is shared depends on which external service is
providing the customer information.

Open Login Account Creation  
When customers log in to the customer portal using open login, these events occur the rst time they log in from the
selected service provider.

1. The customer aempts to access a password-protected customer portal page and is directed to the login
window. Or, the customer clicks the Sign Up link, opening the Create an Account page.

2. The customer selects one of the open login options.
3. If the customer is not logged in to the external service provider, the third-party login page opens to allow login,

and the provider veries the customer’s identity.
4. The external service lets the customer know that the customer portal is requesting specic account information

and asks the customer for permission to share that information.
5. When the customer grants permission for the external site to share information with the customer portal, the

site gives the customer’s information to Oracle Service Cloud.
6. A contact record for the customer is created in the database using the email address and, if available, the

customer’s name. The contact record uses the customer’s email address as the login/username with a null
password.

7. The customer is logged in to the customer portal.

Open Login Process  
The following events occur when a customers has logged in to the customer portal using one of their external service
accounts but try to use open login again.

1. The customer tries to access the customer portal by logging in through an external site.
2. The external site veries the customer and sends the customer’s information to the customer portal. If the

customer previously gave permission for more than one-time use, this step occurs automatically and the
customer does not see the provider page, but is logged in to the customer portal and directed to the Support
Home page.

3. The customer portal looks up the customer using the account’s user ID (provided by Twier and Facebook
and stored as contact2channel_type.userid) or the OpenID URL (used by Google, Yahoo, and other OpenID
providers, stored as openid_account.openid_url).

4. The customer portal then checks the customer’s login, which should still be the email address, as it was when
the contact record was created. If the login is blank for any reason (for example, a sta member deleted it), the
login eld is repopulated with the customer’s email address.

1198



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

5. The customer’s email address, as received from the external site, is checked against the email address in the
database. If the two addresses do not match, the contact record is updated with the email address from the
external site. However, the customer’s login, which is the original email address, is not updated.

6. If the customer does not have a rst or last name in the database but that information is received from the
external service, the rst name and last name elds are updated in the database.

The process is slightly dierent when customers use an open login from a dierent external site than the one used to
create the contact record in Oracle Service Cloud. If the open login account the customer is using on this visit does not
match other open logins associated with the contact record, the account’s OpenID URL is added to the contact record.
By default, customers who use external login to access your customer portal, whether through open login or pass-
through authentication, cannot edit their account information on the Account Seings (prole.php) page. If you remove
the external login condition on the FormSubmit buon—which we recommend against doing—you must also add the
allow_external_login_updates aribute before the Save Changes buon is available to customers.

Change the Open Login Options  
You can change the open login options or remove them entirely.

1. Open /views/templates/standard.php.
2. Locate sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" />, which should be in the last

lines of code for the rst instance of the AccountDropdown widget.
3. Add the open_login_providers aribute to the widget and set the value to the providers you want to list.

 open_login_providers="facebook,google"/>

4. Save the le.

Remove the Open Login Options  
Remove the open login options to restrict customers from using another provider to login to your customer portal.

1. Open /views/templates/standard.php.
2. Locate this text, which should be in the last lines of code for the rst instance of the AccountDropdown widget.

sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" />

3. Add the open_login_providers aribute to the widget and set the value to null.
4. Add the label_open_login_intro aribute and set its value to null.

open_login_providers="" label_open_login_intro=""/>

5. Save the le.

Remove All OpenLogin Widgets  
This example removes all OpenLogin widgets from the default Create an Account page requiring customers to create a
new user account.

1. Open a Create an Account page le:
◦ /views/pages/utils/create_account.php

◦ /views/pages/mobile/utils/create_account.php
2. Delete the following lines of code.
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<div class="rn_ThirdPartyLogin">
 <p class="rn_ServicesMessage">#rn:msg:SERVICES_MSG#</p>
 <p class="rn_LoginUsingMessage">#rn:msg:LOG_IN_OR_REGISTER_USING_ELLIPSIS_MSG#</p>
 <div class="rn_OpenLogins">
 <rn:widget path="login/OpenLogin"/>
 <rn:widget path="login/OpenLogin"
 controller_endpoint="/ci/openlogin/oauth/authorize/twitter"
 label_service_button="Twitter"
 label_process_explanation="#rn:msg:CLICK_BTN_TWITTER_LOG_TWITTER_MSG#"
 label_login_button="#rn:msg:LOG_IN_USING_TWITTER_LBL#"/>
 <rn:widget path="login/OpenLogin"
 controller_endpoint="/ci/openlogin/openid/authorize/google"
 label_service_button="Google"
 label_process_explanation="#rn:msg:CLICK_BTN_GOOGLE_LOG_GOOGLE_VERIFY_MSG#"
 label_login_button="#rn:msg:LOG_IN_USING_GOOGLE_LBL#"/>
 <rn:widget path="login/OpenLogin"
 controller_endpoint="/ci/openlogin/openid/authorize/yahoo"
 label_service_button="Yahoo"
 label_process_explanation="#rn:msg:CLICK_BTN_YAHOO_LOG_YAHOO_VERIFY_MSG#"
 label_login_button="#rn:msg:LOG_IN_USING_YAHOO_LBL#"/>
 <rn:widget path="login/OpenLogin"
 controller_endpoint="/ci/openlogin/openid/authorize"
 label_service_button="Wordpress" openid="true"
 preset_openid_url="http://[username].wordpress.com"
 openid_placeholder="[#rn:msg:YOUR_WORDPRESS_USERNAME_LBL#]"
 label_process_explanation="#rn:msg:YOULL_LOG_ACCT_WORDPRESS_TAB_ENTER_MSG#"
 label_login_button="#rn:msg:LOG_USING_YOUR_WORDPRESS_ACCOUNT_LBL#"/>
 <rn:widget path="login/OpenLogin"
 controller_endpoint="/ci/openlogin/openid/authorize"
 label_service_button="OpenID" openid="true"
 openid_placeholder="http://[provider]"
 label_process_explanation="#rn:msg:YOULL_OPENID_PROVIDER_LOG_PROVIDER_MSG#"
 label_login_button="#rn:msg:LOG_IN_USING_THIS_OPENID_PROVIDER_LBL#"/>
 </div>
</div>
<p class="rn_CreateAccountMessage">#rn:msg:CONTINUE_CREATING_ACCOUNT_ELLIPSIS_CMD#</p>

3. Save the le.

Remove an OpenLogin Widget  
You can remove the OpenLogin widget associated with specic external providers.

1. Open a Create an Account page le:
◦ /views/pages/utils/create_account.php

◦ /views/pages/mobile/utils/create_account.php
2. Identify the widgets you want to remove.

The code <rn:widget path="login/OpenLogin"/> is for the Facebook widget. All other widgets include
the provider’s name in the controller_endpoint, label_service_buon, label_process_explanation, and
label_login_buon aributes.
For example, here is the widget to log in with a Google account as it appears on the Create an Account page.
<rn:widget path="login/OpenLogin"
 controller_endpoint="/ci/openlogin/openid/authorize/google"
 label_service_button="Google"
 label_process_explanation="#rn:msg:CLICK_BTN_GOOGLE_LOG_GOOGLE_VERIFY_MSG#"
 label_login_button="#rn:msg:LOG_IN_USING_GOOGLE_LBL#"/>

3. Delete the lines of code associated with open login providers you want to remove from the page.
4. Save the page.
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Change Labels on OpenLogin Widgets  
This example demonstrates editing the labels on the Google OpenLogin widget.

1. Open one of these les:

◦ /views/templates/standard.php

◦ /views/templates/mobile.php

2. Locate sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" />, which should be in the last
lines of code for the rst instance of the AccountDropdown widget.

a. To change the label on the login buon, add the label_login_button aribute to the widget and set the
value to the new message.
sub:openlogin_google:label_login_button="Use Google to log in now"/>

b. To change the label that explains the process to customers, add the label_process_explanation aribute
and set the value to the new message.
sub:openlogin_google:label_process_explanation="Google will verify you and log you in instantly."

c. To change the “What will happen:” label in the explanation area, add the label_process_header aribute
and set the value to the new message.
sub:openlogin_google:label_process_header="Why it is okay to do this" />

d. To edit the email labels that appear when the service provider authenticates the customer
but does not provide the customer’s email address, add any of the following widget aributes
to the code: label_email_address, label_email_prompt, label_email_prompt_cancel_button,
label_email_prompt_submit_button, and label_email_prompt_title.
sub:openlogin_google:label_email_prompt="We’ll get you started just as soon as you enter your
 email address." />

e. To change the text label, add the label_service_button aribute and set the value to the new message.
sub:openlogin_google:label_service_button="Google Login" />

3. Save the le.

How Contacts are Created in the Database  
Oracle Service Cloud creates contact records with information passed from the external service.

When the customer portal receives the customer’s email address from the external provider, it creates a contact record
in the Oracle database. (If the email address is not received, a contact cannot be created and customers see a message
that asks them for their email address or lets them know an account was not created.) If the customer’s name has been
transferred from the external provider, that information is also added to the contact record. The Login eld of the record
on the agent desktop (which is the Username eld on the customer portal) is populated with the customer’s email
address, and the password is null. Customers whose contact records have been disabled on the agent desktop cannot
log in through open login.

Customers can continue to log in through open login with a null password, but they cannot log in to the customer portal
directly until they set a password using the standard customer portal protocol. Customers who log in through open
login can create a password on the customer portal by clicking the Change Your Password link on the Account Seings
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page. They can then log in to the customer portal using their login and password, or they can continue to log in through
open login.

Oracle Service Cloud keeps track of all open login accounts a customer uses to prevent duplicate contact records. When
a customer’s email address is provided from the external service and it matches an email address in the database,
the application nds the existing contact and adds a new channel or OpenId for the customer. The database table
openid_accounts keeps track of the dierent OpenID accounts customers use to log in by mapping OpenIDs to contact
IDs.

OpenID URLs  
Using the openid_placeholder aribute of the OpenLogin widget, you can preset the URL that displays and include the
user name.

By default, the WordPress and OpenID widgets use the OpenID protocol and have the openid aribute set to true.

For the WordPress OpenLogin widget, you would edit the widget code to remove the preset_openid_url aribute and
include:

openid_placeholder="https://openid.wordpress.com/[username]"

However, you might want the increased security by hiding the URL so the customer sees only a user name eld
to complete. The preset_openid_url aribute denes the URL but does not expose it on the page. The reference
implementation uses these aributes to hide the URL and name the default placeholder “Your WordPress username.”

preset_openid_url="https://openid.wordpress.com/[username]"
openid_placeholder="[#rn:msg:YOUR_WORDPRESS_USERNAME_LBL#]"

Support Home Page  

Remove the Search Field from Home Pages  
You can remove the search eld from your Customer Portal home pages.

1. Open one of the following les:
◦ /views/pages/home.php

◦ /views/pages/mobile/home.php

◦ /views/pages/social/home.php
2. Delete the following code from the page.

<div class="rn_SearchControls">
 <h1 class="rn_ScreenReaderOnly">#rn:msg:SEARCH_CMD#</h1>
 <form method="get" action="/app/results">
 <rn:container source_id="KFSearch">
 <div class="rn_SearchInput">
 <rn:widget path="searchsource/SourceSearchField" initial_focus="true"/>
 </div>
 <rn:widget path="searchsource/SourceSearchButton" search_results_url="/app/results"/>
 </rn:container>
 </form>
</div>
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3. Save the le.

Congure the VisualProductCategorySelector Widget  
The VisualProductCategorySelector widget displays products (by default) or categories on the Support Home page.

1. Open one of the Home page les:

◦ /views/pages/home.php

◦ /views/pages/mobile/home.php

2. Locate <rn:widget path="navigation/VisualProductCategorySelector"/>.
3. To display categories instead of products, add the type aribute.

<rn:widget path="navigation/VisualProductCategorySelector" type="category"/>

4. To change the default number of products or categories that are displayed, add the maximum_items aribute.
<rn:widget path="navigation/VisualProductCategorySelector" maximum_items="12"/>

5. To display a specic list of products or categories, add the top_level_items aribute and use the ID numbers,
separated by commas, of the products or categories you want to list.
<rn:widget path="navigation/VisualProductCategorySelector" top_level_items="12,13,6"/>

6. Save the le.

Edit the Popular Published Answers Section  
The Support Home page contains a list of popular published answers generated by the TopAnswers widget.

1. Open one of the home page les:

◦ /views/pages/home.php

◦ /views/pages/mobile/home.php

2. To customize the heading, select all code between the <h2> and </h2> tags and enter a title.
<h2>#rn:msg:POPULAR_PUBLISHED_ANSWERS_LBL#</h2>

3. To change the number of displayed answers, edit the limit aribute of the TopAnswers widget to replace 5 with
the number of answers you want to display.
<rn:widget path="reports/TopAnswers" show_excerpt="true" limit="5"/>

4. To shorten the length of the displayed answer excerpt from the default (and maximum) value of 256 characters,
add the excerpt_max_length aribute and set the value to the length you want.
<rn:widget path="reports/TopAnswers" show_excerpt="true" limit="5" excerpt_max_length="100"/>

5. To remove excerpts of answers, remove the show_excerpt aribute from the TopAnswers widget.
<rn:widget path="reports/TopAnswers" limit="5" />

6. To open URL and le aachment answers in the same tab instead of opening in a new tab, as they do by
default, add the url_type_target aribute and set it to “_self.”
<rn:widget path="reports/TopAnswers" show_excerpt="true" limit="5" url_type_target="_self" />

7. Save the le.
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Edit the Recent Community Discussions Section  
The Support Home page displays a list of recent community discussions, generated by the RecentlyAnsweredQuestions
widget, that have a best answer selection.

1. Open one of the home page les:

◦ /views/pages/home.php

◦ /views/pages/mobile/home.php

2. To customize the heading, select all code between the <h2> and </h2> tags and enter a title.
<h2>#rn:msg:RECENT_COMMUNITY_DISCUSSIONS_LBL#</h2>

3. To display only questions that have a best answer designated by the original author of the question, add the
answer_type aribute to the widget and set its value to “author.”
<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"
 answer_type="author"/>

4. To display only questions that have a best answer designated by a moderator of the question, add the
answer_type aribute to the widget and set its value to “moderator.”
<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"
 answer_type="moderator"/>

5. To change the number of displayed questions, edit the maximum_questions aribute of the widget to replace 5
with the number of questions you want to display.
<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"/>

6. To shorten the length of the displayed question excerpt from the default (and maximum) value of 256
characters, add the excerpt_max_length aribute and set the value to the length you want.
<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"
 excerpt_max_length="100"/>

7. To shorten the length of the displayed best answer excerpt from the default value of 150 characters, add the
answer_text_length aribute and set the value to the length you want.
<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"
 answer_text_length="100"/>

8. To remove excerpts of questions, remove the show_excerpt aribute from the RecentlyAnsweredQuestions
widget.
<rn:widget path="discussion/RecentlyAnsweredQuestions" maximum_questions="5"/>

9. To change the size of avatars from the default value of medium, add the avatar_size aribute to the widget and
select one of the following values: none, small, large, or xlarge.
<rn:widget path="discussion/RecentlyAnsweredQuestions" show_excerpt="true" maximum_questions="5"
 avatar_size="small"/>

10. Save the le.

Add an Unanswered Questions Section  
You can display a list of recent community discussions on your Support Home page.

1. Open /views/pages/home.php le.
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2. Add this code where you want the section to appear.
<div class="rn_PopularSocial">
<div class="rn_Container">
 <h2>Unanswered Questions</h2>
 <rn:widget path="discussion/RecentlyAskedQuestions" show_excerpt="true" maximum_questions="4"
 questions_with_comments="no_comments"/>
 <span class="rn_DiscussionsLink">
 <a href="/app/social/questions/lists/kw/*#rn:sessions#">#rn:msg:SHOW_MORE_COMMUNITY_DISCUSSIONS_LBL#</
a>
 </span>
</div>
</div>

3. Save the le.

Search Results Pages  

Edit the Search Results Page  
You can change what information displays related to published answers from the knowledge base and community
discussions.

1. Open one of the Search Results page les:
◦ /views/pages/results.php

◦ /views/pages/mobile/results.php
2. Find the container that includes the SourceResultListing widget.
3. To change the number of displayed answers from the default of ve, edit the per_page aribute and set the

value to the number of answers you want to display.
<rn:container source_id="KFSearch" per_page="3">

4. To hide the Published Answers section if no search results match, add the hide_when_no_results aribute and
set it to true.
<rn:widget path="searchsource/SourceResultListing"
 label_heading="#rn:msg:PUBLISHED_ANSWERS_LBL#" hide_when_no_results="true" />

5. To disable search term highlighting in the Published Answers section, add the highlight aribute and set it to
false.
<rn:widget path="searchsource/SourceResultListing"
 label_heading="#rn:msg:PUBLISHED_ANSWERS_LBL#" highlight="false" />

6. To truncate the length of published answers to something other than the default value of 200 characters, add
the truncate_size aribute and set it to the value you want.
<rn:widget path="searchsource/SourceResultListing"
 label_heading="#rn:msg:PUBLISHED_ANSWERS_LBL#" truncate_size="100" />

7. To change the number of community discussions from the default of ve, change the per_page aribute and set
the value to the number of discussions you want to display.
<rn:container source_id="SocialSearch" per_page="8">

8. To remove dates from community discussions, add the show_dates aribute and set its value to false.
<rn:widget path="searchsource/SocialResultListing"
 label_heading="#rn:msg:RESULTS_FROM_THE_COMMUNITY_LBL#"
 more_link_url="/app/social/questions/list" show_dates="false"/>
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9. To hide the Results from the Community section if no search results match, add the hide_when_no_results
aribute and set it to true.
<rn:widget path="searchsource/SocialResultListing"
 label_heading="#rn:msg:RESULTS_FROM_THE_COMMUNITY_LBL#"
 more_link_url="/app/social/questions/list" hide_when_no_results="true" />

10. To disable search term highlighting in the Results from the Community section, add the highlight aribute and
set it to false.
<rn:widget path="searchsource/SocialResultListing"
 label_heading="#rn:msg:RESULTS_FROM_THE_COMMUNITY_LBL#"
 more_link_url="/app/social/questions/list" highlight="false" />

11. To truncate the length of community questions to something other than the default value of 200 characters,
add the truncate_size aribute and set it to the value you want.
<rn:widget path="searchsource/SocialResultListing"
 label_heading="#rn:msg:RESULTS_FROM_THE_COMMUNITY_LBL#"
 more_link_url="/app/social/questions/list" truncate_size="100" />

12. To hide selected metadata, add the show_metadata aribute and remove the comment_count or best_answers
options.
<rn:widget path=”searchsource/SocialResultListing” show_metadata=”comment_count” />

13. Save the le.

Edit the Published Answers Page  
You can modify what displays on the Published Answer page.

Your customers access the Published Answers page by clicking the Show More Published Answers link on the Support
Home page or on the Results page. They can enter search terms and lter published answers by product and category.

1. Open one of the Answer List page les:

◦ /views/pages/answers/list.php

◦ /views/pages/mobile/answers/list.php
2. To change the number of displayed answers from the reference implementation’s default value of ve answers,

follow these steps.
a. Change the per_page aribute of the container that includes the SourceResultListing widget and set the

value to the number of answers you want to display.
<rn:container source_id="KFSearch" per_page="8" history_source_id="KFSearch">

b. Add the per_page aribute to the Multiline widget and set the same value as you dened in the
SourceResultListing widget.
<rn:widget path="reports/Multiline" show_answer_update_date_field="false" per_page="8"/>

3. To truncate the length of published answers to something other than the default value of 200 characters, follow
these steps.

a. Add the truncate_size aribute to the SourceResultListing widget and set it to the value you want.
<rn:widget path="searchsource/SourceResultListing" more_link_url="" truncate_size="100" />

b. Add the truncate_size aribute to the Multiline widget and set it the same value as you dened in the
SourceResultListing widget.
<rn:widget path="reports/Multiline" show_answer_update_date_field="false" truncate_size="100"/>

4. To remove the icon for the RSS feed, delete <rn:widget path="knowledgebase/RssIcon" />.
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5. Save the le.

Change the Search Report  
You can use any report on the Answers page, as long as it contains the answers.special_seings lter.

The default search report on the Published Answers page is Answers–Complex Expressions Search Default.
1. Open one of these les:

◦ /views/pages/answers/list.php

◦ /views/pages/mobile/answers/list.php
2. Locate <rn:container report_id="176">.
3. Replace 176 with the report ID of the answers report you want to open when the customer conducts a search.
4. Save the le.

Check for the answers.special_seings Filter  
Answers reports used on the customer portal must contain the answers.special_seings lter.

If you are using a custom answers report, make sure it includes the answers.special_seings lter.

All standard answers reports for the customer portal already include the lter.
1. Double-click Reports Explorer in Analytics.
2. Locate the custom answers report you want to use on the customer portal, right-click it, and select Edit.
3. Click Filters.
4. Locate special seings is null in the list of lters on the window.
5. If the special seings lter is not present in the list, add it.

a. Click Add Filter.
b. Enter special seings is null in the Name eld.
c. Enter answers.special_seings in the Expression eld.
d. Select is null in the Operator drop-down menu.

Note:  If the “is null” option is not available in the Operator menu, be sure the check box for Make
this lter selectable at runtime is cleared.

e. Click OK.
6. Click OK.
7. Click Save.

Use a Grid Report on the Published Answers Page  
You can use a grid report to display search results in tabular form.

By default, the Published Answers page displays search results in a multiline format.
1. Open /views/pages/answers/list.php.
2. Locate this code.

<rn:widget path="reports/Multiline" show_answer_update_date_field="false" />

3. Replace the Multiline widget with the Grid widget.
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<rn:widget path="reports/Grid" show_answer_update_date_field="false" />

4. Save the le.

Copy the Standard Answers Report  
Users with report editing permissions can use the Standard Answers report to create a custom report and replaces the
standard report.

1. Double-click Reports Explorer in Analytics.
2. Click Find.
3. Select ID in Find Using.
4. Select Equal To.
5. Enter 176 in the eld.
6. Click Find.
7. Right-click the report and select Copy.
8. Enter a name for the custom report you are going to create in the Name eld.
9. Click OK.

Edit a Custom Report  
This example edits a custom report to open answers in a separate window.

Users must have report edit permissions.
1. With the Reports explorer open, locate the custom report you want to edit.
2. Right-click the report and select Edit.
3. Right-click the Summary column and select Insert New Column Before.
4. Enter Link Target in the Heading eld.
5. Place the cursor in the Expression eld to the right of the Available Columns/Functions.
6. Enter if((answers.type = 2 | answers.type = 3), '_blank') in the Expressions eld.
7. Click OK.
8. Right-click the Link Target column and select Hide Column.
9. Right-click the Summary column and select Edit Format.

10. Click  URL > Advanced URL Denition .
11. Click Target and select Link Target.
12. Click OK.
13. Click Home.

a. Click Denition.
b. Select View.
c. Note the AcId number.

14. Close the Report Denition window.
15. Click Save.
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Replace the Standard Report  
This example replaces the standard report with a custom report that opens URL and le aachment answers in a
separate browser window.

1. Open /views/pages/answers/list.php.
2. Locate <rn:container report_id="176">.
3. Replace 176 with the ID number for the custom report you created.
4. Save the le.

Edit the Results from the Community Page  
Community discussions can be ltered by product, age, and questions that have a best answer.

1. Open /views/pages/social/questions/list.php.
2. To remove the Filter by Product lter, delete this code.

<rn:widget path="searchsource/SourceProductCategorySearchFilter"
 verify_permissions="true"/>

3. To remove the Filter by Age lter, delete this code.
<rn:widget path="searchsource/SourceFilter" filter_type="updatedTime"
 label_default="--" labels="#rn:php:/RightNow/Utils/Config::getMessage(LAST_DAY_LBL)
 . ',' . /RightNow/Utils/Config::getMessage(LAST_WEEK_LBL) . ','
 . /RightNow/Utils/Config::getMessage(LAST_MONTH_LBL) . ','
 . /RightNow/Utils/Config::getMessage(LAST_YEAR_LBL)#"
 label_input="#rn:msg:FILTER_BY_AGE_LBL#"/>

4. To remove the Filter by Best Answer lter, delete this code.
<rn:widget path="searchsource/SourceFilter" filter_type="numberOfBestAnswers"
 label_default="--" labels="#rn:php:/RightNow/Utils/Config::getMessage(YES_LBL)
 . ',' . /RightNow/Utils/Config::getMessage(NO_LBL)#"
 label_input="#rn:msg:FILTER_BY_BEST_ANSWER_LBL#"/>

5. To change the number of displayed questions from the default of 10, edit the per_page aribute in the container
that includes the SocialResultListing widget and change its value to the number of questions you want to
display.
<rn:container source_id="SocialSearch" per_page="5" history_source_id="SocialSearch">

6. To truncate the length of published questions to something other than the default value of 200 characters, add
the truncate_size aribute to the SocialResultListing widget and set it to the value you want.
<rn:widget path="searchsource/SocialResultListing" more_link_url="" truncate_size="100" />

7. To hide selected metadata, add the show_metadata aribute and remove the comment_count or best_answers
options.
<rn:widget path=”searchsource/SocialResultListing” show_metadata=”comment_count” />

8. Save the le.
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Congure the Contact Us Section  
You can congure the contact us section of the Search Results page.

1. Open the Search Results page to congure the sidebar.
2. To remove the Ask a Question link, add the channels aribute to the ContactUs widget and set the value to

community, chat, feedback.
<rn:widget path="utils/ContactUs" channels="community,chat,feedback" />

3. To remove the Ask the Community link, add the channels aribute to the ContactUs widget and set the value to
question, chat, feedback.
<rn:widget path="utils/ContactUs" channels="question,chat,feedback" />

4. To remove the Live Chat link, add the channels aribute to the ContactUs widget and set the value to question,
community, feedback.
<rn:widget path="utils/ContactUs" channels="question,community,feedback" />

5. To remove the Give Feedback link, add the channels aribute to the ContactUs widget and set the value to
question, community, chat.
<rn:widget path="utils/ContactUs" channels="question,community,chat" />

6. Save the page.

Congure Recently Viewed Section  
You can congure the recently viewed items available on various pages including the Search Results, the Answer Details,
and the Community Results pages.

1. Open the le for the page you want to congure the sidebar.
2. To change the Recently Viewed heading, add the label_heading aribute to the RecentlyViewedContent widget

and set the value to the new heading.
<rn:widget path="discussion/RecentlyViewedContent" label_heading="New Label" />

3. To change the number of recently viewed answers and discussions from the default of 5, add the content_count
aribute to the widget and set the new value. (If you do not want to set a limit, set the aribute to 0.)
<rn:widget path="discussion/RecentlyViewedContent" content_count="3" />

4. To change the number of characters that are displayed for each answer or discussion from the default value of
50 characters, add the truncate_size aribute and set the new value.
<rn:widget path="discussion/RecentlyViewedContent" truncate_size="100" />

5. To display only discussions, add the content_type aribute and set the value to questions.
<rn:widget path="discussion/RecentlyViewedContent" content_type="questions" />

6. To display only published answers, add the content_type aribute and set the value to answers.
<rn:widget path="discussion/RecentlyViewedContent" content_type="answers" />

7. To remove the Recently Viewed section, delete <rn:widget path="discussion/RecentlyViewedContent"/>.
8. Save the page.
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Congure the SummaryResultListing Widget  
The SummaryResultListing widget displays the Community Results section in the sidebar of the Published Answers
page to show community discussions related to the search term.

1. Open one of these les and locate the associated code.

◦ /views/pages/answers/list.php
<rn:widget path="searchsource/SummaryResultListing"
 label_heading="#rn:msg:COMMUNITY_RESULTS_LBL#" results_type="SocialQuestions"
 more_link_url="/app/social/questions/list" per_page="10"/>

◦ /views/pages/social/questions/list.php

 <rn:widget path="searchsource/SummaryResultListing" hide_when_no_results="true"
 label_heading="#rn:msg:PUBLISHED_ANSWERS_LBL#" per_page="10"/>
 

2. To change the number of displayed results from the default of 10, change the value of the per_page aribute to
the value you want.

3. To disable search term highlighting, add the highlight aribute and set it to false.
4. To change the length of the question title from the default of 35 characters, add the truncate_size aribute and

set it to the length you want.
5. To hide the heading when there are no related community discussions, add the hide_when_no_results aribute

and set it to true.
6. Save the le.

Congure the Provide Feedback Dialog  
The Provide Feedback dialog opens when customers click the Give Feedback sidebar link.

If the customer is not logged in, the dialog contains two required elds: the email address and a feedback eld. If the
customer is logged in, the incident created by the feedback is automatically associated with the customer and only the
Your Feedback eld appears on the dialog.

1. Open the Search Results page.
2. To change the Provide Feedback header, add the label_dialog_title aribute to the ContactUs widget and set

its value to the new header.
<rn:widget path="utils/ContactUs" label_dialog_title="New Provide Feedback Header Label" />

3. To change the conrmation message, add label_feedback_confirmation="New Confirmation Message" to the
widget code.

4. To point your customers to a dierent feedback page instead of the Provide Feedback window, follow these
steps:

a. Create the page you want to open, name it, and place it in /cp/customer/development/views/pages
folder or a subfolder.

b. Add the feedback_page_url aribute to the Contact Us widget and set its value to the new page you have
created.
<rn:widget path="utils/ContactUs" feedback_page_url="/app/utils/your_custom_feedback_page" />

5. Save the page.
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Answer and Question Details Pages  

Overview of the Answer and Question Details Pages  
When customers select an answer on an Answers report, the Answer Details page opens. When customers select a
Recent Community discussion on the Support Home page, the Question Details page opens.

The Answer Details and Question Details pages (views/pages/answers/detail.php or views/pages/social/questions/
detail.php) display:

• a summary of the answer or question

• the question and answer text

• the dates when the question or answer were published and updated

• any les that are aached to the answer or question

• a feedback section

• links for sharing, printing, emailing, and subscribing

The page sidebar has a section for channels that customers can use to contact your organization, a section for recently
viewed content, and a section for related answers from your knowledge base.

The Details pages also contain the GuidedAssistant widget, which walks customers through a series of questions to help
them locate information that may provide additional information to answer their questions.

Depending on how an answer was congured, it may or may not be visible to all customers on the Answer Details page.
Many factors control answer visibility, including:

• the answer status

• the answer access level

• the answer language

• the associated products and categories

• conditional sections

• the customers’ SLAs

This is also true of answers that have been reached through a guide on your customer portal. For example, if an answer
or section of an answer is available only to customers whose SLAs give them permission to view certain answer access
levels, that answer will not be visible to customers without that SLA even if they click an answer in a guide.

If you want to keep the answers in your knowledge base from being available to the general public, you must require
login on both the Answers and the Answer Details page. If both pages do not have the same login requirement, a
warning will appear when you stage and promote your customer portal.

For search engine optimization, the source code for the Answer Details page includes a tag that contains the title of the
answer. The title is all lowercase and the words are separated by hyphens. Punctuation in a title is escaped and the title
uses a maximum of 80 characters.

The link tag is automatically added to the <head> section of the answer and uses this form.
<link rel="canonical" href="http://www.example.com/app/answers/detail/a_id/<answerID>
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 /~/<answer-title>" />

To view this tag, view the source code for an answer page in your web browser. Here is an example.
<link rel='canonical' href='http://yoursiteurl.com/app/answers/detail/a_id/47/
 ~/how-do-i-use-my-cell-phone-as-a-mobile-hotspot%3F'/>

Edit Date Labels on the Answer Details Page  
This example shows how to edit the labels associated with the publication date of the answer and the date it was last
updated.

1. Open /views/pages/answers/detail.php.
2. Locate this code.

#rn:msg:PUBLISHED_LBL# <span itemprop="dateCreated"><rn:field name="Answer.CreatedTime" /></span>
&nbsp;&nbsp;|&nbsp;&nbsp;&nbsp; #rn:msg:UPDATED_LBL# <span itemprop="dateModified"><rn:field 
name="Answer.UpdatedTime" /></span>

3. Edit the code to reect your label changes.
This answer was first published on <span itemprop="dateCreated"><rn:field 
name="Answer.CreatedTime" /></span> &nbsp;&nbsp;|&nbsp;&nbsp;&nbsp; 
This answer was last updated on <span itemprop="dateModified">
<rn:field name="Answer.UpdatedTime" /></span>

4. To remove the dates, delete the code you previously located.
#rn:msg:PUBLISHED_LBL# <span itemprop="dateCreated"><rn:field name="Answer.CreatedTime" /></span>
&nbsp;&nbsp;|&nbsp;&nbsp;&nbsp; #rn:msg:UPDATED_LBL# <span itemprop="dateModified"><rn:field 
name="Answer.UpdatedTime" /></span>

5. Save the le.

Disable Search Term Highlighting  
You can turn o the default highlighting of search terms on the Answer Details page.

1. Open one of the answer details les:

◦ /views/pages/answers/detail.php

◦ /views/pages/mobile/answers/detail.php

2. Locate this code.
<h1 id="rn_Summary"><rn:field name="Answer.Summary" highlight="true"/></h1>
...
<rn:field name="Answer.Question" highlight="true"/>
...
<rn:field name="Answer.Solution" highlight="true"/>

3. Remove highlight="true" from each line.
4. Save the le.
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Modify the File Aachments Display  
You can congure the display to sort the aachments, remove le size information, remove thumbnails, and prevent the
display of le aachments.

1. Open /views/pages/answers/detail.php.
2. Locate <rn:widget path="output/DataDisplay" name="Answer.FileAttachments"

label="#rn:msg:ATTACHMENTS_LBL#"/>.
3. To sort the le aachment list numerically and alphabetically, edit the DataDisplay widget to add the

sort_by_filename aribute and set its value to true.
<rn:widget path="output/DataDisplay" name="Answer.FileAttachments"
 label="#rn:msg:ATTACHMENTS_LBL#" sort_by_filename="true" />

4. To remove the le aachment size information, add the display_file_size aribute and set it to false.
<rn:widget path="output/DataDisplay" name="Answer.FileAttachments"
 label="#rn:msg:ATTACHMENTS_LBL#" display_file_size="false" />

5. To remove le aachment thumbnail, add the display_thumbnail aribute and set it to false.
<rn:widget path="output/DataDisplay" name="Answer.FileAttachments"
 label="#rn:msg:ATTACHMENTS_LBL#" display_thumbnail="false"/>

6. To prevent displaying answer le aachments on the answer details page, delete this code.
<div id="rn_FileAttach">
 <rn:widget path="output/DataDisplay" name="Answer.FileAttachments"
 label="#rn:msg:ATTACHMENTS_LBL#" />
</div>

7. Save the le.

GuidedAssistant Guides  
The sets of branching questions used by the GuidedAssistant widget are called guides, and they are created on the
administration interface.

The default Answer Details page includes the GuidedAssistant widget, which helps your customers locate solutions to
their problems when they answer questions presented to them on the customer portal. Guides can be associated with
individual answers so that when your customers select an answer, the GuidedAssistant widget appears on the Answer
Details page. (If the selected answer is not associated with a guide, the widget will not appear.) Or you can select one
guide you want to always appear on the page regardless of which answer is opened.

If you dene a guide ID in the widget code, that guide will be displayed even if another guide is already associated with
the selected answer. If the widget code does not specify a guide, the page displays the guide associated with the answer
that is selected, if it has one.

You can congure guides to pass parameters to the Ask a Question page. If, for instance, your customer reaches the end
of a guide and still doesn’t have the answer to a question, you can ask for product and category information that will be
passed in the URL to the Ask a Question page to populate those elds automatically.

Be sure to check your guides as they appear on the Customer Portal. Image type questions can benet from additional
conguration to display eectively. It’s a good idea to leave additional white space to the left of the image and include
the caption as part of the image rather than separately. Images that are roughly 350 pixels by 200 pixels display
optimally.
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Open the Same Guide on Every Answer  
By dening the guide ID in the widget code, you can override the answer-guide association and specify one guide open
on the Answer Details page regardless of the answer.

1. Open one of the following les:

◦ /views/pages/answers/detail.php

◦ /views/pages/mobile/answers/detail.php

2. Locate the following code.
<rn:widget path="knowledgebase/GuidedAssistant" />

3. Edit the GuidedAssistant widget to add the static_guide_id aribute and specify the ID of the guide.
<rn:widget path="knowledgebase/GuidedAssistant" static_guide_id="21" />

4. Save the page.

Open Guides in a Separate Window  
You can open guides from the Answer Details page in a separate window.

1. Create a PHP page that contains the GuidedAssistant widget and place it in a development folder.
In this example, we’ll call the page guide.php and place it in the /development/views/pages folder.
<rn:meta title="Guides" template="standard.php" />
 <div id="rn_PageContent">
 <div class="rn_AnswerDetail">
 <dl class="rn_Overview">
 <rn:widget path="knowledgebase/GuidedAssistant"/>
 </dl>
 </div>
 </div>

2. Open /views/pages/answers/detail.php.
3. Locate this code.

<rn:widget path="knowledgebase/GuidedAssistant"/>

4. Edit the GuidedAssistant widget.

◦ To add the popup_window_url aribute to specify the guide page you just created.
<rn:widget path="knowledgebase/GuidedAssistant" popup_window_url="/app/guide" />

◦ To add the call_url_new_window aribute.
<rn:widget path="knowledgebase/GuidedAssistant" call_url_new_window="true" />

5. Save the le.

Open Answers Inline  
You can open answers inline instead of a separate window, which is the default.

1. Open /views/pages/answers/detail.php.
2. Locate this code.
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<rn:widget path="knowledgebase/GuidedAssistant"/>

3. Edit the GuidedAssistant widget to add the target aribute.
<rn:widget path="knowledgebase/GuidedAssistant" target="_self" />

4. Save the le.

Display Only the Current Question  
You can congure the GuidedAssistant widget to display only the current question.

1. Open /views/pages/answers/detail.php.
2. Locate <rn:widget path="knowledgebase/GuidedAssistant"/>.
3. Add the single_question_display aribute and set it to true.

<rn:widget path="knowledgebase/GuidedAssistant" single_question_display="true" />

4. Save the le.

Edit Labels on the GuidedAssistant Widget  
These aributes can change the labels displayed in your GuidedAssistant widget.

1. Open /views/pages/answers/detail.php.
2. Locate <rn:widget path="knowledgebase/GuidedAssistant"/>.
3. Edit the GuidedAssistant widget labels.

◦ To change the default label "Please consult the following information", edit the label_answer_result
aribute.

◦ To change the default label "Launch the Troubleshooter", edit the label_popup_launch_button aribute.
<rn:widget
 path="knowledgebase/GuidedAssistant" popup_window_url="/app/guide"
 label_popup_launch_button="Open Help System" />

◦ To change the default label "Go back to previous question", edit the label_question_back aribute.

◦ To change the default label "Start over", edit the label_start_over aribute.

◦ To change the default label "OK", edit the label_text_response_button aribute.

◦ To change the default label "(Null)", edit the label_text_result aribute.

4. Save the le.

Remove the GuidedAssistant Widget  
You can remove the GuidedAssistance widget from your site.

1. Open /views/pages/answers/detail.php.
2. Delete <rn:widget path="knowledgebase/GuidedAssistant"/>.
3. Save the le.
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Add Fields on the Answer Details Page  
You might want to provide additional information about the answer being viewed on the Answer Details page.

1. Open one of the listed les and nd the line of code:

◦ /views/pages/answers/detail.php
<rn:field name="Answer.Question" highlight="true"/>

◦ /views/pages/mobile/answers/detail.php
<rn:field name="Answer.Solution" highlight="true"/>

2. Add the appropriate code below the previously located code.

◦ To add the answer’s ID, add <p>Answer ID <rn:field name="Answer.ID" /></p>.

◦ To add product information for the answer, add <rn:widget path="output/DataDisplay"
name="Answer.Products" />.

◦ To add category information for the answer, add <rn:widget path="output/DataDisplay"
name="Answer.Categories" />.

3. Save the le.

Change the Answer Feedback Page  
You can create an Answer Feedback page where your customers will be redirected when they submit feedback that is
below the specied threshold.

For this example, let’s assume that your page name is new_answer_feedback_page.php and that you have stored it in
views/pages/answers.

1. Open /views/pages/answers/detail.php.
2. Add the feedback_page_url aribute to the AnswerFeedback widget and set its value to the new feedback page.

<rn:widget path="feedback/AnswerFeedback"
 label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#"
 feedback_page_url="/app/answers/new_answer_feedback_page" />

3. Save the le.

Oer Alternate Feedback Options  
You can oer your customers more than the default Yes and No options as a response to the answer feedback question.

You can dene up to ve options, which appear as stars by default, but can also appear as percentage ratings.
1. Open /views/pages/answers/detail.php.
2. Add the options_count aribute to the AnswerFeedback widget.

<rn:widget path="feedback/AnswerFeedback"
 label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#" options_count="5" />

3. If you want the options to appear in descending order rather than the default ascending order, add the
options_descending aribute to the code.
<rn:widget path="feedback/AnswerFeedback" 
 label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#" options_count="5"
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 options_descending="true" />

4. If you want to explain the rating scale, you can edit the label_title aribute as well.
<rn:widget path="feedback/AnswerFeedback"
 label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#" options_count="5"
 label_title="Rate this answer for helpfulness by selecting between 1 (low) and 5 
 (high) stars" />

5. If you want to display a numerical percentage rating instead of the default stars that are used when more than
two responses are oered, add the use_rank_labels aribute.
<rn:widget path="feedback/AnswerFeedback"
 label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#" options_count="5"
 label_title="How useful is this answer?" use_rank_labels="true" />

6. Save the le.

Remove Answer Feedback  
You can remove the answer feedback from the Answer Details page.

1. Open /views/pages/answers/detail.php.
2. Delete this code.

<rn:widget path="feedback/AnswerFeedback" label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#"/>

3. Save the le.

Change the Rating Threshold  
You can let customers provide more detailed feedback.

1. Open /views/pages/answers/detail.php.
2. Locate <rn:widget path="feedback/AnswerFeedback" label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#" />.
3. Edit the code to add the dialog_threshold aribute to the widget.

a. Let customers provide feedback on the answer, set the threshold to 0.
b. Oer every customer the ability to provide feedback, regardless of the answer rating, set the threshold

to the total number of feedback options (2 for the default Yes/No buons, 5 for the default multiple
feedback options).
<rn:widget path="feedback/AnswerFeedback"
 label_title="#rn:msg:IS_THIS_ANSWER_HELPFUL_LBL#" options_count="5"
 dialog_threshold="3" />

c. Oer Alternate Feedback Options.
4. Save the le.

Remove Links from the Details Pages  
You can remove all or some of the links at the boom of the Answer Details and the Social Question Details pages.

1. Do one of the following.
a. To edit the answer details page, open /views/pages/answers/detail.php.
b. To edit the questions detail page, open /views/pages/social/questions/detail.php.
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2. To remove the Notify Me link, delete this code.
<rn:condition logged_in="true">
 <rn:widget path="notifications/AnswerNotificationIcon" />
</rn:condition>

3. To remove the Email This Page link, delete this code.
<rn:widget path="utils/EmailAnswerLink" />

4. To remove the Print link, delete this code.
<rn:widget path="utils/PrintPageLink" />

5. To remove the Share link, delete this code.
<rn:widget path="utils/SocialBookmarkLink" />

6. Save the le.

If you remove the Notify Me link, you should also remove the Manage Your Notications link on the sidebar of the
Account Overview page.

Edit the List of Social Networking Sites on the Share Link  
You can add, remove, or rearrange the options displayed by editing the SocialBookmarkLink widget.

By default, the Share link lets you share answer content with the Facebook, Twier, LinkedIn, and Reddit social
networking sites.

1. Open one of the Details page les:

◦ /views/pages/answers/detail.php.

◦ /views/pages/social/questions/detail.php.

2. Locate <rn:widget path="utils/SocialBookmarkLink" />.
3. Edit the code to individually list each site as comma-separated values for the sites aribute.

<rn:widget path="utils/SocialBookmarkLink" sites="Facebook > Post to Facebook >
 http://facebook.com/sharer.php?u=|URL|, Twitter > Tweet this >
 http://twitter.com/home?status=|TITLE|+|URL|, LinkedIn > Post to LinkedIn >
 http://www.linkedin.com/shareArticle?mini=true&url=|URL|&title=|TITLE|&summary
 =|TITLE|&source=|URL|, Reddit > Post to Reddit > http://reddit.com/submit?
 url=|URL|&title=|TITLE|" />

4. To remove one or more of the default links, delete the associated code from the sites aribute.
This example removes the LinkedIn link.
<rn:widget path="utils/SocialBookmarkLink" sites="Facebook > Post to Facebook >
 http://facebook.com/sharer.php?u=|URL|, Twitter > Tweet this > http://twitter.com/
 home?status=|TITLE|+|URL|, Reddit > Post to Reddit >
 http://reddit.com/submit?url=|URL|&title=|TITLE|" />

5. Save the le.

Congure the ContactUs Widget  
The ContactUs widget appears on the Answer and Question Details pages and also on the Search Result pages.

This procedure uses the answers/detail page, but the steps are the same for the social/questions/detail page.
1. Open /views/pages/answers/detail.php.
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2. To remove the Ask a Question link, add the channels aribute to the ContactUs widget and set the value to
community, chat, feedback.
<rn:widget path="utils/ContactUs" channels="community,chat,feedback" />

3. To remove the Ask the Community link, add the channels aribute to the ContactUs widget and set the value to
question, chat, feedback.
<rn:widget path="utils/ContactUs" channels="question,chat,feedback"/>

4. To remove the Live Chat link, add the channels aribute to the ContactUs widget and set the value to question,
community, feedback.
<rn:widget path="utils/ContactUs" channels="question, community,feedback" />

5. To remove the Give Feedback link, add the channels aribute to the ContactUs widget and set the value to
question, community, chat.
<rn:widget path="utils/ContactUs" channels="question, community,chat" />

6. Save the page.

Related Topics
• Congure the ConditionalChatLink Widget

• Congure the SiteFeedback Widget

Congure the SiteFeedback Widget  
The Provide Feedback dialog is generated by the SiteFeedback widget contained in the ContactUs widget.

If a customer is not logged in, the dialog contains two required elds: the email address and a feedback eld. If a
customer is logged in, the incident created by the feedback is automatically associated with the customer and only the
Your Feedback eld appears on the dialog. This procedure uses the answers/detail page, but the steps are the same for
the social/questions/detail page.

1. Open /views/pages/answers/detail.php.
2. To open a dierent customer portal page instead of the Provide Feedback window, follow these steps.

a. Create the page you want to open, name it, and place it in /cp/customer/development/views/pages
folder or a subfolder.

b. Add the feedback_page_url aribute to the ContactUs widget, making sure the path begins with/app.
<rn:widget path="feedback/SiteFeedback" />

c. Edit the code to add a value for the feedback_page_url aribute. The value must begin with /app.
<rn:widget path="utils/ContactUs" feedback_page_url="/app/utils/your_custom_feedback_page" />

d. Save detail.php.
3. To edit labels on the Provide Feedback dialog, add the appropriate label aribute to the ContactUs widget and

change its value to the new label.

◦ To change the label on the Give Feedback link, add label_link="New Give Feedback Link Label".

◦ To change the Provide Feedback header of the window, add label_dialog_title="New Provide Feedback
Header Label".

◦ To change the Email label, add label_email_address="New Email Address Label".

◦ To change the Your Feedback label, add label_comment_box="New Your Feedback Label".

◦ To change the Submit buon label, add label_send_button="New Submit Button Label".
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◦ To change the Cancel buon label, add label_cancel_button="New Cancel Button Label".

◦ To change the conrmation message, add label_feedback_confirmation="New Confirmation Message".

4. Save the page.

Congure the Published Answers Section  
The related answers feature suggests answers based on the answer relationships generated when sta members
manually relate answers or when customers use your site.

1. Open /views/pages/answers/detail.php.
2. To change the Published Answers heading, add the label_title aribute to the RelatedAnswers widget and set

the value to the new heading.
<rn:widget path="knowledgebase/RelatedAnswers" label_title="New Label" />

3. To change the number of published answers from the default of 5, add the limit aribute to the
RelatedAnswers widget and set the new value.
If you do not want to set a limit, set the aribute to 0.
<rn:widget path="knowledgebase/RelatedAnswers" limit="3" />

4. To change the number of characters that are displayed for each answer from the default value of 0 characters
(which prevents truncation), add the truncate_size aribute and set the new value.
<rn:widget path="knowledgebase/RelatedAnswers" truncate_size="50" />

5. To remove the Published Answers section, delete <rn:widget path="knowledgebase/RelatedAnswers" />.
6. Save the le.

Congure the RelatedKnowledgebaseAnswers Widget  
The sidebar section called Related Answers displays the most popular published answers and is rendered by the
RelatedKnowledgebaseAnswers widget.

1. Open views/pages/social/questions/detail.php.
2. To change the Related Answers heading, add the label_heading aribute to the RelatedKnowledgebaseAnswers

widget and set the value to the new heading.
<rn:widget path="discussion/RelatedKnowledgebaseAnswers" limit="4" label_heading="New Label" />

3. To change the number of published answers from the page default of 4, set the value of the limit aribute to
the number you want.

4. To change the number of characters that are displayed for each answer from the default value of 50 characters
(which prevents truncation), add the truncate_title_at aribute and set the new value. Set the value to 0 if you
do not want to truncate the answer title.
<rn:widget path="discussion/RelatedKnowledgebaseAnswers" limit="4" truncate_title_at="100" />

5. To remove the Related Answers section, delete <rn:widget path="discussion/RelatedKnowledgebaseAnswers"
limit="4" />.

6. Save the le.
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Submit a Question Pages  

Submit a Question Pages  
Your customer portal contains a page that lets customers ask questions to your support sta and another that lets them
ask questions to the community.

When the Ask a Question tab is clicked, the rst page that opens (/views/pages/ask.php) lets your customers submit
questions to your support sta, which automatically creates an incident in your database. This page contains a link to
another page (/views/pages/social/ask.php) that lets customers pose their question to the community, instead of
submiing it to your organization.

The standard workow for submiing a question to your support sta on the Customer Portal reference
implementation was designed for an optimal customer experience. It asks for only an email address, without requiring
account creation or login. When customers are already logged in, the email eld is hidden and they need only enter
information about their question. When customers submit a question, an incident is created in your database so that
your support sta can resolve the issue. The created incident is linked automatically to the customer if a contact record
exists in the database. If a contact does not already exist, a new contact record is created. The new contact record
contains only the email address, so customers will be required to use account assistance if they want to log in to the
customer portal in the future. Customers are not logged in to the customer portal after submiing a question, whether
their contact record already exists or is created through the question submission.

When customers who are not logged in click the Ask our Community link after clicking the Ask a Question tab, they
are taken to the login window to either log in or create an account. Customers who are logged in but who do not have a
community display name will be asked to create a display name before submiing questions to the community.

Related Topics
• Asking a Question (video)

Display the Ask a Question Page Based on User Actions  
The RN Condition page tag lets you hide part of the page if the condition specied in the tag is not met.

Before you implement this requirement, you should consider the usability issues of conditionally hiding and exposing
page navigation. Particularly for customers using screen readers, the presence of a new navigation tab may not be
evident when the conditions that trigger its appearance have occurred.

Among the aributes of the RN Condition page tag are answers_viewed, questions_viewed, content_viewed
(combination of answers and questions/discussions), and searches_done.

1. Open /views/templates/standard.php.
2. Locate this code.

<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#"
 link="/app/ask" pages="ask, ask_confirm"/></li>

3. To hide the tab based on the number of answers customers view, add the answers_viewed condition above the
code for the Ask a Question tab.
In this example, customers must view three answers before the tab is displayed.
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<rn:condition answers_viewed="3">

4. To hide the tab based on the number of community discussions (questions) customers view, add the
questions_viewed condition above the code for the Ask a Question tab.
<rn:condition questions_viewed="2">

5. To hide the tab based on the combination of answers and community discussions customers view, add the
content_viewed condition above the code for the Ask a Question tab.
<rn:condition content_viewed="4">

6. To hide the tab based on the number of searches customers perform, add the searches_done aribute to the
NavigationTab widget.
<li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#"
 link="/app/ask" pages="ask, ask_confirm" searches_done="2" /></li>

a. If your only criteria for displaying the Ask a Question page is the number of searches your customers
perform, you should use the searches_done aribute of the NavigationTab widget instead of the RN
Condition searches_done aribute.
Because the RN Condition tag identies a search only when a page is turned or refreshed, this is a less
ideal option for displaying the Ask a Question page. Assume you set the searches_done aribute for
RN Condition to 2. Now assume a customer conducts one search, reviews the list but does not click an
answer or otherwise leave or refresh the answers list page, and then conducts a second search. In this
case, the Ask a Question tab will not be displayed until another page is opened or the current page is
refreshed.

b. To count searches performed by the customer regardless of whether page turns occur (that is, regardless
of whether an answer resulting from a search is viewed), use the searches_done aribute of the
NavigationTab widget rather than the searches_done aribute of the RN Condition tag.

7. To use a combination of options for hiding the navigation tab, use the else condition as shown in this example,
which hides the tab until either three answers have been viewed or two searches have been conducted.
<rn:condition answers_viewed="3">
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#"
 link="/app/ask" pages="ask, ask_confirm"/></li>
<rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:ASK_QUESTION_HDG#"
 searches_done="2" link="/app/ask" pages="ask, ask_confirm"/></li>
</rn:condition>

8. Add the following code on a separate line below the code for the Ask a Question tab.
</rn:condition>

9. Save the le.

Remove the Subject Field  
The Subject eld on the Ask a Question page populates the Subject eld of the created incident.

If you remove the Subject eld from the Ask A Question page, the incident Subject eld contains the rst 80 characters
of the customer’s question.

1. Open /views/pages/ask.php.
2. Delete the following line of code from the le to remove the Subject eld when the customer is not logged in.

<rn:widget path="input/FormInput" name="Incident.Subject" required="true"
 label_input="#rn:msg:SUBJECT_LBL#"/>

3. Delete the following lines of code from the le to remove the Subject eld when the customer is logged in.
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<rn:condition logged_in="true">
 <rn:widget path="input/FormInput" name="Incident.Subject" required="true"
 initial_focus="true" label_input="#rn:msg:SUBJECT_LBL#"/>
</rn:condition>

4. Save the le.

Populate the Product Field  
You can automatically populate the product eld on the Ask a Question page to a default value.

Although the default_value aribute takes precedence over any other method of populating the products and
categories for the ProductCategoryInput widget, you can also populate the product and category elds by passing
the ID numbers in the URL used to open the page. This lets you populate dierent products and categories when
customers access the Ask a Question page from dierent external pages. You can also use POST parameters, but the
URL parameters will override the POST parameter if both are used.

1. Open /views/pages/ask.php.
2. Locate <rn:widget path="input/ProductCategoryInput" name="Incident.Product" />.
3. Add the default_value aribute to the ProductCategoryInput widget to specify the product you identied the ID

number for.
<rn:widget path="input/ProductCategoryInput" name="Incident.Product" 
 default_value="421,47" />

4. Save the le.

Congure File Aachments  
The standard Ask a Question page lets your customers aach an unlimited number of les to the question they submit,
but you can restrict the number or type of le aachments or prevent them from adding aachments.

1. Open /views/pages/ask.php.
2. Locate <rn:widget path="input/FileAttachmentUpload"/>.
3. To restrict the type of aachments, add the valid_le_extensions aribute to the FileAachmentUpload widget.

<rn:widget path="input/FileAttachmentUpload" valid_file_extensions="doc,docx,xls,xlsx" />

4. To change the default label that displays if customers try to aach a le type that is not valid, add the
label_invalid_extension aribute and dene the label.
<rn:widget path="input/FileAttachmentUpload" valid_file_extensions="doc,docx,xls,xlsx"
 label_invalid_extension="You may attach only the following file types:%s" />

5. To restrict the number of le aachments, add the max_aachments aribute to the widget.
<rn:widget path="input/FileAttachmentUpload" max_attachments="5" />

6. To change the default label that displays if customers exceed the allowable number of aachments, add the
label_max_aachment_limit aribute and dene the label.
<rn:widget path="input/FileAttachmentUpload" max_attachments="5"
 label_max_attachment_limit="You may upload only 5 files to your question."/>

7. To remove the ability to aach les to a question, delete <rn:widget path="input/FileAttachmentUpload"/>.
8. To require a minimum number of le aachments, add the min_required_aachments aribute to the

FileAachmentUpload widget.
<rn:widget path="input/FileAttachmentUpload" min_required_attachments="2" />
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9. To change the default label that displays if customers do not aach the minimum number of aachments, add
the label_min_required aribute and dene the label.
<rn:widget path="input/FileAttachmentUpload" min_required_attachments="2"
 label_min_required="You must attach at least 2 files before submitting your question."/>

10. Save the le.

Dene Form Completion Time  
By default, a customer’s partially completed form remains valid for 30 minutes, but you can change that value.

1. Locate SUBMIT_TOKEN_EXP conguration seing in RightNow User Interface/General/Security.
2. Click Value and enter the number of minutes at which you want the form to expire.
3. Click Save.

Edit the Standard Conrmation Page  
You can edit the standard conrmation page that opens when a customer submits a question on the Ask a Question
page, or you can display a dierent conrmation page.

1. Open /views/pages/ask_conrm.php.
2. To change the “Your question has been submied!” heading, locate the following line of code and edit the

content between the <h1> tags with your new heading.
<h1>#rn:msg:YOUR_QUESTION_HAS_BEEN_SUBMITTED_LBL#</h1>

3. Save the le.
4. To display a dierent conrmation page, follow these steps.

a. Open /views/pages/ask.php.
b. Locate <rn:widget path="input/FormSubmit" label_button="#rn:msg:CONTINUE_ELLIPSIS_CMD#"

on_success_url="/app/ask_confirm" error_location="rn_ErrorLocation" />.
c. Edit the code to replace "/app/ask_confirm" with the page of your choice.

5. Save the le.

Create an Incident Rule for Incident Receipts  
You can set up an incident rule to send an email receipt to your customers when they submit a question on the Ask a
Question page.

1. Open Rules in  Conguration > Site Conguration .
2. Click Incident.
3. Click Edit.
4. If an initial state does not already exist for the incident rule base, create one.

a. Right-click States and select New State.
b. Enter a name, such as Initial State.
c. Select Initial State.
d. Click Save.

5. Right-click the initial state and select New Rule.
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6. Enter a name for the incident rule in the Rule Name eld.
7. Click Add IF Condition Based On.
8. Select  Incident > Source .
9. Click the arrow in the Select Operator eld and select Equals.

10. Expand the End-User Pages heading in the incident source menu and select Ask a Question.
11. Click Add Action–Then.
12. Select  Email > Send Receipt Email .
13. Click Save.
14. Expand the initial state again and determine the location of the incident receipt rule.
15. If the incident receipt rule is not at the top of the list, drag it to the top position.
16. Click Activate.
17. Click OK.
18. Click OK.
19. If incidents are in the Null state or a state that has been removed, you should move them into an active state in

the rule base.
20. Click the drop-down arrow to select a state where the incidents should be moved.
21. Click Save.

Congure the Social Ask Page  
On the Social Ask a Question page, customers who are logged in but who do not have a community user prole are
asked to enter a display name before continuing.

1. Open /views/pages/social/ask.php.
2. To change the “Submit a question to the support community” heading, locate the following line of code and

edit the content between the <h1> tags with your new heading.
<h1>#rn:msg:SUBMIT_A_QUESTION_TO_SUPPORT_COMMUNITY_MSG#</h1>

3. To remove the product selector, delete <rn:widget path="input/ProductCategoryInput"
name="SocialQuestion.Product" verify_permissions="Create"/>.

4. To clear the check box for “Email me when a new comment is posted,” add the subscribe_me_default aribute
to the DiscussionAuthorSubscription widget and set its value to false.
<rn:widget path="notifications/DiscussionAuthorSubscription"
 subscribe_me_default="false"/>

5. To remove the “Email me when a new comment is posted” check box, delete <rn:widget path="notifications/
DiscussionAuthorSubscription"/>.

6. Save the le.

How SmartAssistant Works  
When your customers can’t nd an answer to their question in your knowledge base, they can submit a question to your
support sta.

If you have an incident business rule dened to do so, the SmartAssistant suggested answers feature uses natural
language processing to display a list of answers from your knowledge base that may contain the information your
customers are seeking. The list of suggested answers and community discussions is presented to customers before they
nish submiing their questions. If one of the suggested answers addresses the customer’s concern, they can avoid
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submiing an incident. Besides displaying a list of proposed answers to customer questions, SmartAssistant can also
display standard text or a single, specic answer.

Customers also see SmartAssistant suggested answers and community discussions when they submit a question to the
community. However, incident rules do not apply to community content.

Create an Incident Rule for SmartAssistant  
You need to create an incident rule to use SmartAssistant.

1. Double-click Rules in  Conguration > Site Conguration .
2. Click Incident.
3. Click Edit.
4. If an initial state does not already exist for the incident rule base, create one.

a. Right-click  States > New State .
b. Enter a name in the State Name eld.
c. Select Initial State.
d. Click Save.

5. Right-click the state you want to add the rule to and select New Rule.
6. Enter a name for the incident rule in the Rule Name eld.
7. Click Add IF Condition Based On.
8. Select  Incident > Source .
9. Click the arrow in the Select Operator eld and select Equals.

10. Expand the End-User Pages heading in the incident source menu and select SmartAssistant on Ask a
Question.

11. Click Add Action–Then.
12. You can display a list of suggested answers, append standard text, or append the text of a specic answer.

◦ To display a list of suggested answers, select  Append Thread > Append SmartAssistant Response to
Response Field .

◦ To display standard text, select  Append Thread > Append Response Template to Response Field  and
add the standard text response in the Then action.

◦ To display an answer, select  Append Thread > Append Existing Solution (by Answer ID) to Response
Field  and enter the ID of the answer you want to display.

13. Click Save.
14. Click  Activate > OK > OK .
15. If incidents are in the Null state or a state that has been removed, you should move them into an active state in

the rule base.
a. Click the drop-down arrow to select a state where the incidents should be moved.
b. Click Save.

Congure SmartAssistant  
A variety of options exist for conguring SmartAssistant on the administration interface.

You can enable optimization so that the parameters that control SmartAssistant accuracy are analyzed to determine
their optimum values.

1. To enable SmartAssistant optimization (which determines the optimum values for the parameters that control
accuracy), follow these steps.

a. Locate KF_SA_OPTIMIZATION_ENABLE in Common/Knowledge Base/Knowledge Foundation.
b. Click the Value eld and select Yes.
c. Click Save.

2. To congure the number of days optimization data is valid, follow these steps.
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a. Locate KF_SA_OPTIMIZATION_DATA_PURGE_DAYS in Common/Knowledge Base/Knowledge
Foundation.

b. Click the Value eld and enter the number of days after which the optimization data is removed.
c. Click Save.

3. To change the ratio of suggested published answers to community discussions from the default of 60 percent
answers to 40 percent community results, follow these steps.

a. Locate SA_RESULTS_COUNT_RATIO in Common/Knowledge Base/SmartAssistant.
b. Click the Value eld and enter the ratio of answers to community results using the format 60A:40S.
c. Click Save.

4. To dene whether product and category lters should be used for SmartAssistant community results, follow
these steps.

a. Locate SA_USE_SOCIAL_PROD_CAT_FILTER in Common/Knowledge Base/SmartAssistant.
b. Click the Value eld and enter 1 for product lter only, 2 for category lter only, and 3 for both product

and category lters.
c. Click Save.

5. To dene the number of answers to display as solutions instead of links, follow these steps.
a. Locate SA_WF_SOLNS_EXPAND_CNT in RightNow User Interface/Support/SmartAssistant.
b. Click the Value eld and enter the number of expanded suggested answers you want to appear on the

customer portal.
c. Click Save.

6. To change the number of answers suggested from the default value of 5, follow these steps.
a. Locate SA_NL_MAX_SUGGESTIONS under RightNow User Interface/Support/SmartAssistant.
b. Click the Value eld and enter the number of suggested answers you want to appear on the customer

portal.
c. Click Save.

7. To limit suggested answers by category or product, follow these steps.
a. Navigate to the RightNow User Interface/Support/SmartAssistant conguration seings.
b. To limit by categories, click the Value eld for SA_SUGGEST_LIMIT_CAT_LVL and enter a value to indicate

how you want to restrict suggested answers by category sub-levels.
c. To limit by products, click the Value eld for SA_SUGGEST_LIMIT_PROD_LVL and enter a value to

indicate how you want to restrict suggested answers by products sub-levels.
d. Click Save.

Modify SmartAssistant Relevancy  
Two conguration seings let you control how an incident’s subject and body inuence the way answers are returned in
SmartAssistant.

The SA_DISPATCH_RATIO conguration seing includes two values to dene whether the answers are returned based
on the hybrid mode used by the SA_SUBJ_BODY_WEIGHTS conguration seing or on the standard SmartAssistant
mode. The default value “100 0” means that they will always be returned by the rst mode, while “0 100” means they
will always be returned by the standard mode. The two values do not have to add up to 100. Instead they represent the
odds that the rst or second mode will be chosen. These conguration seings are also used to identify similar answers
for the Smart Merge feature in Service.

1. Locate the conguration seings in Common/Knowledge Base/Answer Search.
2. In the SA_SUBJ_BODY_WEIGHTS value eld, enter three values, separated by a single space, to indicate how

you want to weight an incident’s subject, body, and bonus value for the hybrid SmartAssistant mode.
3. In the SA_DISPATCH_RATIO value eld, enter two values, separated by a single space, to dene the ratio for

returning SmartAssistant answers using the mode from SA_SUBJ_BODY_WEIGHTS.
4. Click Save.
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Congure the SmartAssistantDialog Widget  
You can modify what is displayed when customers submit their question.

1. Open the appropriate ask.php le.

◦ Open /views/pages/ask.php.

◦ Open /views/pages/social/ask.php.

2. To remove conditions for the SmartAssistant Dialog widget so that it will always propose suggested answers,
locate this code and delete all but the <rn:widget path="input/SmartAssistantDialog"/> line.
<rn:condition content_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog"/>
</rn:condition>

3. To change the content viewed or searches done condition, change the code values to the numbers you want.
<rn:condition content_viewed="2" searches_done="1">

4. To open the answers that customers click in a separate window, add the display_inline aribute to the
SmartAssistantDialog widget and set it to false.
<rn:widget path="input/SmartAssistantDialog" display_inline="false" />

5. To redirect customers to a page other than the default Support Home page when their questions are answered,
add the solved_url aribute to the SmartAssistantDialog widget.
<rn:widget path="input/SmartAssistantDialog" solved_url="/app/answers/list" />

6. To remove the SmartAssistantDialog widget and never suggest answers to your customers, delete this code.
<rn:condition content_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog"/>
</rn:condition>

7. Save the le.

Using the Do Not Create Incident Action with SmartAssistant  
You might use the business rule action called Do Not Create Incident if your organization has stopped supporting an
older product.

Instead of creating an incident for an unsupported product, you might want to direct customers to the Answers page,
where they can search the knowledge base for an answer to their question. In this case, the SmartAssistantDialog
widget noties them that their question hasn’t been submied and then directs them to the Answers page.

Another time you might want to combine a Do Not Create Incident rule with a SmartAssistant rule is when your
organization requires additional information before a customer’s question can be submied. In this case, the rule base
performs a basic form validation. It checks to see if the information is complete and, if it isn’t, directs the customer back
to the Ask a Question page without creating an incident from the partial question. You might use this when you have a
eld on the page that you need customers to answer only under certain conditions. For example, assume you have an
Urgency eld that is not required except when customers select the Troubleshooting category. When customers select
Troubleshooting without selecting an Urgency option, you can automatically direct them back to the submit a question
form to complete the eld before submiing the question.

Prevent Incident Creation Using the SmartAssistant  
This example demonstrates how to prevent an incident creation because your organization no longer supports the
selected product.
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Create the SmartAssistant rule. See Congure the SmartAssistantDialog Widget .

When the question meets the conditions specied in the Do Not Create Incident rule and the customer clicks the
Continue buon, the SmartAssistantDialog widget appears. Instead of displaying the suggested answers and standard
message bases, the widget displays the labels you have designed specically for this situation. For example, you can tell
customers an incident cannot be submied because your organization no longer oers the selected product. You can
then direct them to the Answers page, where they can search the knowledge base for the answer to their question.

1. Create the standard text message you want to display when the SmartAssistant window opens to tell customers
their question has not been submied.
In this example, you might create standard text for a product end-of-life.

“Because this product has reached end-of-life for customer support, we can no
 longer accept
questions about it. For help, please see our knowledge base of existing answers, 
which will open when you click the Close button.”

2. Create the Do Not Create Incident rule by following the example in Create an Incident Rule for SmartAssistant.
IF Incident.Source equals End-User Pages > SmartAssistant on Ask a Question
AND Incident.Product equals Call Plans > Prepay
THEN Do Not Create Incident
AND Append Response Template to Response Field (Select the standard text you created.)
AND Stop Processing Rules

3. On the Rules editor, drag the Do Not Create Incident rule so it appears above the SmartAssistant rule in the list
of rules within the state.

Note:  The rules engine needs to process the Do Not Create Incident rule before it gets to the
SmartAssistant rule. Otherwise, customers will see suggested answers rst, but will still have the
option to submit their question, triggering an error message if Call Plans > Prepay is selected.

4. Click Activate.

Redirect Customers  
You can point your customers to specic pages when they aempt to submit questions to your support team.

1. Open /views/pages/ask.php.
2. Locate the following lines of code.

<rn:condition content_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog"/>
</rn:condition>

3. Delete the three lines with condition tags.
If you don’t remove the conditional text tags around the widget, the widget won’t appear to customers who
have viewed the necessary number of answers or performed searches, even if they select the Call Plans >
Prepay product. All they will see is an error message telling them their question cannot be submied.

4. Edit the SmartAssistantDialog widget code to add the dnc_label_ aributes.
Your code will resemble the following.
<rn:widget path="input/SmartAssistantDialog" dnc_label_cancel_button="Close"
 dnc_label_banner="Your question cannot be submitted." dnc_label_dialog_title="This
 question cannot be submitted." dnc_redirect_url="/app/answers/list" />

5. Save the le.

Require Information on the Ask a Question Page  
Your business needs may require you obtain additional information from customers when they use the Ask a Question
page.

1. Open /views/pages/ask.php.
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2. Locate the following lines of code.
<rn:condition content_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog"/>
</rn:condition>

3. Delete the three lines with condition tags.
If you don’t remove the conditional text tags around the widget, the widget won’t appear to customers who
have viewed the necessary number of answers or performed searches, even if they select the Troubleshooting
category. All they will see is an error message telling them their question cannot be submied.

4. Edit the SmartAssistantDialog widget code to add the dnc_label_ aributes.
Your code will resemble the following.
<rn:widget path="input/SmartAssistantDialog" dnc_label_cancel_button="Complete Form"
 dnc_label_banner="We need more information before submitting your question."
 dnc_label_dialog_title="More information required" />

5. Save the le.

Account Pages  

Change the Account Overview Page Headings  
This example show you how to customize the page heading on the Account Overview page.

1. Open /views/pages/account/overview.php.
2. Locate <h2><a class="rn_Questions" href="/app/account/questions/

list#rn:session#">#rn:msg:MY_SUPPORT_QUESTIONS_LBL#</a></h2>.
3. Edit the code with your revised heading.

<h2><a class="rn_Questions" href="/app/account/questions/list#rn:session#">
Incidents You Have Submitted</a></h2>

4. Save the le.

Display Service Contracts on the Account Overview Page  
If your organization uses SLAs and you want them to be visible to your customers, you can add the Service Contracts
section to the Account Overview page.

1. Open /views/pages/account/overview.php.
2. Locate this code:

<a href="/app/social/questions/list/author/#rn:profile:socialUserID#/kw/*#rn:session#">
#rn:msg:SEE_ALL_MY_DISCUSSION_QUESTIONS_LBL#</a>
</rn:container>
</div>

3. Add this code just after the code you located in the previous step.
<h2><class="rn_Contracts">#rn:msg:SERVICE_CONTRACTS_LBL#</strong></h2>
<div class="rn_Contracts">
 <rn:widget path="reports/Grid" report_id="185" label_caption=
"#rn:msg:YOUR_SERVICE_CONTRACTS_LBL#"/>
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</div>

4. Save the le.

Add Login Information to the Account Overview Page  
You can add the login statistics reports to the Account Overview page.

1. Open /views/pages/account/overview.php.
2. Locate this code:

<a href="/app/social/questions/list/author/#rn:profile:socialUserID#/kw/*#rn:session#">
#rn:msg:SEE_ALL_MY_DISCUSSION_QUESTIONS_LBL#</a>
</rn:container>
</div>

3. Add the appropriate code just after the code you located in the previous step.

◦ To show Contact Login Statistics, add <rn:widget path="reports/Grid" report_id="10046"
label_caption="Previous Logins" date_format="date_time"/>.

◦ To show Unsuccessful Login Aempts by Contact, add <rn:widget path="reports/Grid"
report_id="10047" label_caption="Previous Unsuccessful Login Attempts" date_format="date_time"/>.

4. Save the le.

Edit the Links Sidebar on the Account Overview Page  
The Account Overview page sidebar contains links to the Account Seings, Change Your Password, Notications, and
Public Prole pages.

1. Open /views/pages/account/overview.php.
2. Locate this code.

<div class="rn_SideRail">
 <fieldset>
 <legend>Links</legend>
 <ul>
 <li><a href="/app/account/profile#rn:session#">#rn:msg:
 UPDATE_YOUR_ACCOUNT_SETTINGS_CMD#</a></li>
 <li><a href="/app/account/change_password#rn:session#">#rn:msg:
 CHANGE_YOUR_PASSWORD_CMD#</a></li>
 <li><a href="/app/account/notif/list#rn:session#">#rn:msg:
 MANAGE_YOUR_NOTIFICATIONS_LBL#</a></li>
 <rn:condition is_active_social_user="true">
 <li><a href="/app/public_profile/user/#rn:profile:socialUserID#">
 #rn:msg:VIEW_YOUR_PUBLIC_PROFILE_LBL#</a></li>
 </rn:condition>
 </ul>
 </fieldset>
</div>

◦ To remove the links sidebar, delete the code you located.

◦ To change the Links heading, locate the following line of code and replace Links with your new heading.
<legend>Links</legend>

◦ To remove the Update Account Seings link, delete this code.
<li><a href="/app/account/profile#rn:session#">#rn:msg:
 UPDATE_YOUR_ACCOUNT_SETTINGS_CMD#</a></li>
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◦ To change a label, locate the message base and replace it with the new label.
<li><a href="/app/account/profile#rn:session#">Change your contact
 information</a></li>

◦ To remove the Change Your Password link, delete this code.
<li><a href="/app/account/change_password#rn:session#">#rn:msg:
 CHANGE_YOUR_PASSWORD_CMD#</a></li>.

◦ To remove the Manager Your Notications link, delete this code.
<li><a href="/app/account/notif/list#rn:session#">#rn:msg:
 MANAGE_YOUR_NOTIFICATIONS_LBL#</a></li>.

◦ To remove the View Your Public Prole link, delete this code.
<rn:condition is_active_social_user="true">
 <li><a href="/app/public_profile/user/#rn:profile:socialUserID#">
 #rn:msg:VIEW_YOUR_PUBLIC_PROFILE_LBL#</a></li>
</rn:condition>

3. Save the le.

Remove the Search Field from the Support History Page  
You can remove the search eld from the support history page.

1. Open /views/pages/account/questions/list.php.
2. Delete the following lines of code.

<div class="rn_SearchControls">
 <h1 class="rn_ScreenReaderOnly">#rn:msg:SEARCH_CMD#</h1>
 <form onsubmit="return false;" class="translucent">
 <rn:container report_id="196">
 <div class="rn_SearchInput">
 <rn:widget path="search/KeywordText" label_text="#rn:msg:
 SEARCH_YOUR_SUPPORT_HISTORY_CMD#"label_placeholder=
 "#rn:msg:SEARCH_YOUR_SUPPORT_HISTORY_CMD#" initial_focus="true"/>
 </div>
 <rn:widget path="search/SearchButton"/>
 </rn:container>
 </form>
 <div class="rn_SearchFilters">
 <rn:widget path="search/ProductCategorySearchFilter" />
 <rn:widget path="search/ProductCategorySearchFilter" filter_type="Category"/>
 </div>
</div>

3. Save the le.

Change the Report on the Support History Page  
By default, the Support History page uses the Questions report.

1. Open one of these les.

◦ /views/pages/account/questions/list.php

◦ /views/pages/mobile/account/questions/list.php

2. Locate <rn:container report_id="196">.
3. Replace 196 with the ID for the standard or custom report you want to use.
4. Save the le.
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Display All Incidents from a Customer’s Organization  
The OrgList2 widget lets customers choose which incidents they see.

1. Open /views/pages/account/questions/list.php.
2. Locate <div class="rn_PageContent rn_Container">.
3. Enter <rn:widget path="search/OrgList" search_on_select="true" /> just above the page container tag.

<rn:widget path="search/OrgList" search_on_select="true" />
<div class="rn_PageContent rn_Container">

4. Save the le.

Congure the Account Seings Page  
The Account Seings page lets your customers update their account information.

The Public Prole section lets users change their display name and avatar. Any contact custom elds given End-user
Read/Write Visibility appear on this page.

1. Open /views/pages/account/prole.php.
2. To edit the title, replace the content between the <h1> tags with the new title.

<h1>#rn:msg:ACCOUNT_SETTINGS_LBL#</h1>

3. To add a eld to the Account Seings page, insert a line of code that calls the FormInput widget in the location
on the page where you want the eld to appear.
To add the alternate email address elds to the page, add these lines of code.
<rn:widget path="input/FormInput" name="Contact.Emails.ALT1.Address"
 label_input="Alternate Email 1" />
<rn:widget path="input/FormInput" name="Contact.Emails.ALT2.Address"
 label_input="Alternate Email 2" />

4. To add a radio buon selection that lets customers opt in to communications from your marketing department,
add <rn:widget path="input/FormInput" name="Contact.MarketingSettings.MarketingOptIn" label_input="Opt
in to marketing communications from us?"/> wherever you want in the block of FormInput widgets on the page.

5. To remove one of the contact elds, locate the line of code that displays the eld and delete it.
To remove the phone eld, you would delete <rn:widget path="input/FormInput"
name="Contact.Phones.HOME.Number" label_input="#rn:msg:HOME_PHONE_LBL#">.

Note:  The prole.php code contains conditional sections that display the physical address elds in a
dierent sequence if the browser is using an Asian language. If you want to remove any or all of these
elds for all languages, be sure to remove them from both conditions.

6. To remove the Public Prole section, delete the code leaving only the closing form and div tags.
 </form>
</div>

7. Save the le.
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Congure the Public Prole Page  
The Public Prole page displays the community user’s display name and avatar, recent community activity, a search
eld, a section that displays the user’s contribution activity, and a print buon.

1. Open views/pages/public_prole.
2. To change the user’s avatar size from the default of extra large, add the avatar_size aribute to the

AvatarDisplay widget and set its value to small, medium, or large.
<rn:widget path="user/AvatarDisplay" avatar_size="medium"/>

3. To change the avatars used in the Recent Activity section from the default of medium, add the avatar_size
aribute to the UserActivity widget and set its value to none, small, large, or xlarge.
<rn:widget path="user/UserActivity" avatar_size="large"/>

4. To remove the “Member since” information from the header, delete #rn:msg:MEMBER_SINCE_LBL# <span
itemprop="dateCreated"><rn:field name="SocialUser.CreatedTime" /></span>.

5. To limit the types of user activity displayed on the Public Prole page, add the type aribute to the UserActivity
widget and set the value to a comma-separated list of only the activity types you want to display.
<rn:widget path="user/UserActivity" type="bestAnswerGivenToUser,commentRatingGivenToUser,
 commentRatingGivenToUser,questionRatingGivenToUser"/>

6. To remove the search eld, delete this code.
<div class="rn_ProfileSearch">
 <fieldset>
 <legend>#rn:msg:SEARCH_USERS_CONTRIBUTIONS_LBL#</legend>
 <rn:widget path="search/SimpleSearch" icon_path=""
 report_page_url="/app/social/questions/list" add_params_to_url="author:userFromUrl"/>
 </fieldset>
</div>

7. To limit the types of contributions displayed in the User’s Contributions section from the default of questions,
comments, and answers, add the contribution_types aribute to the UserContributions widget and select only
the type of contributions you want to display.
<rn:widget path="user/UserContributions" contribution_types="comments, answers"/>

8. To remove the user’s contribution section, delete <rn:widget path="user/UserContributions"/>.
9. To remove the option to print the page, delete <rn:widget path="utils/PrintPageLink"/>.

10. Save the le.

Modify the Avatar Selection Options  
You can modify the order or remove options from the default avatar selections: default, gravatar, and avatar_library.

1. Open /views/pages/account/prole_picture.php.
2. Locate <rn:widget path="input/SocialUserAvatar" />.
3. Edit the widget code to add the avatar_selection_options aribute.

◦ To remove an option, delete the option value from the avatar_selection_options list:
<rn:widget path="input/SocialUserAvatar" 
 avatar_selection_options="default,avatar_library" />

◦ To change the option order, reorder the option values:
<rn:widget path="input/SocialUserAvatar"
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 avatar_selection_options="avatar_library,default,gravatar" />

4. Save the le.

Add or Remove Incident Details on the Question Details Page  
The Additional Details section on the Question Details page provides additional incident and customer information.

1. Open /views/pages/account/questions/detail.php.
2. Locate <div class="rn_AdditionalInfo">.
3. To add an incident detail, add a line of code that adds the DataDisplay widget to the block of DataDisplay code

for incident elds.
For example, you can include the time the incident was closed by adding <rn:widget path="output/DataDisplay"
name="Incident.ClosedTime" label="Closed" />.

4. To remove one of the incident elds, locate the line of code that displays the eld and delete it.
5. Save the le.

Related Topics
• Viewing Response via the Customer Portal (video)

Prevent Customers from Solving Incidents  
You can remove the status eld from the page, which prevents customers from solving incidents.

When customers select “No, I don’t need this question answered now” from the Do You Want a Response? drop-down
menu and then click Submit, the incident’s status is set to Solved automatically.

1. Open /views/pages/account/questions/detail.php.
2. Delete the following line of code.

<rn:widget path="input/FormInput" name="Incident.StatusWithType.Status"
 label_input="#rn:msg:DO_YOU_WANT_A_RESPONSE_MSG#"/>

3. Save the le.

Prevent Customers from Updating Solved Incidents  
You can change the amount of time until an incident can no longer be updated or you can prevent customers from ever
updating a closed incident.

1. Open /views/pages/account/questions/detail.php.
2. Locate this code.

<rn:condition incident_reopen_deadline_hours="168">

3. Edit the code to change the value for the incident_reopen_deadline_hours aribute to 0.
<rn:condition incident_reopen_deadline_hours="0">

4. Save the le.
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Remove Notications from the Notications Page  
The Notications page displays all answer notications, product/category answer notications, discussions, and
product discussion notications the customer is subscribed to.

1. Open /views/pages/account/notif/list.php.
2. To remove the Answer Notications section, delete the following lines of code.

<h2>#rn:msg:ANS_NOTIFICATIONS_LBL#</h2>
<rn:widget path="notifications/AnswerNotificationManager" />

3. To remove the Product/Category Notications section, delete the following lines of code.
<h2>#rn:msg:PRODUCTCATEGORY_ANSWER_NOTIFICATIONS_LBL#</h2>
<rn:widget path="notifications/ProdCatNotificationManager" 
 report_page_url="/app/#rn:config:CP_PRODUCTS_DETAIL_URL#" />

4. To remove the Discussion Notications section, delete the following lines of code.
<h2>#rn:msg:DISCUSSION_NOTIFICATIONS_LBL#</h2>
<rn:container report_id="15104">
 <rn:widget path="reports/ResultInfo" static_filter="User=#rn:profile:socialUserID#"/>
 <rn:widget path="notifications/DiscussionSubscriptionManager" 
 static_filter="User=#rn:profile:socialUserID#"/>
</rn:container>

5. To remove the Product Discussion Notications section, delete the following lines of code.
<h2>#rn:msg:PRODUCT_DISCUSSION_NOTIFICATIONS_LBL#</h2>
<rn:container report_id="15105">
 <rn:widget path="reports/ResultInfo" static_filter="User=#rn:profile:socialUserID#"/>
 <rn:widget path="notifications/DiscussionSubscriptionManager"
 static_filter="User=#rn:profile:socialUserID#" subscription_type="Product"
 label_no_notification="#rn:msg:CURRENTLY_DONT_ANY_DISC_NOTIF_MSG#"/>
</rn:container>

6. Save the le.

Remove Notications from Customer Portal  
If you don’t want customers to subscribe to answers, you’ll need to remove the Notify Me link from the Answer Details
and Social Question Details pages.

1. Remove the Notify Me icon from the Answer Details page.
a. Open /views/pages/answers/detail.php.
b. Delete this code:

<rn:condition logged_in="true">
 <rn:widget path="notifications/AnswerNotificationIcon" />
</rn:condition>

c. Save the le.
2. Remove the Subscribe link from the Social Question Details page.

a. Open views/pages/social/questions/detail.php.
b. Delete this code.

<rn:widget path="notifications/DiscussionSubscriptionIcon"/>

c. Save the le.
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Congure the PasswordInput Widget  
The PasswordInput widget lets you dene the strength of customer passwords on the administration interface.

1. Open /views/pages/account/change_password.php.
2. Locate this code.

<rn:widget path="input/PasswordInput" name="Contact.NewPassword" require_validation="true" 
 require_current_password="true" label_input="#rn:msg:PASSWORD_LBL#"
 label_validation="#rn:msg:VERIFY_PASSWD_LBL#" initial_focus="true"/>

3. To enable the customer’s web browser to auto-complete the password values, add the
disable_password_autocomplete aribute and set it to false.
<rn:widget path="input/PasswordInput" name="Contact.NewPassword" require_validation="true"
 require_current_password="true" disable_password_autocomplete="false" 
 label_input="#rn:msg:PASSWORD_LBL#" label_validation="#rn:msg:VERIFY_PASSWD_LBL#"
 initial_focus="true"/>

4. To remove the Current Password eld from the form so that customers must enter only the new password
value, delete the require_current_password aribute.

5. To remove the validation requirement that causes the Verify Password eld to appear, delete the
require_validation aribute.

6. Save the le.

Community Home Page  

Modify the Community Announcement Text  
You can greet the community or your community moderators with a message tailored to your business needs.

1. Open one of these text les:

◦ /assets/others/community-announcement.txt

◦ /assets/others/moderator-announcement.txt
2. Modify the text, as needed.
3. Save the le.

Modify Common Widgets Used in the Community Page  
You can customize the numerous widgets used in the reference community home page le.

1. To modify the utils/AnnouncementText widget, set the required aribute file_path to the location in /
assets/ for the le containing your announcement text.

2. To modify the discussion/ForumList widget, add or change these aributes and values:
a. To change the date format, modify the last_activity_date_format aribute.

- full_textual (example: January 1, 2000)
- short_textual (example: Jan 1, 2000)
- numeric (example: 1/1/2000)
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b. To include a column of information about the forum, add the show_columns aribute and the value for
the column.

- question_count
- comment_count
- last_activity

This example code removes the column containing information about the last activity.
<rn:widget path="discussion/ForumList" show_column="question_count,comment_count">

c. To change the number of forums shown in the list, modify the max_forum_count aribute.
The max_forum_count is set to 10 by default, but can include as many as 40 forums.

d. To change the amount of text shown in the forum description, modify the maximum_description_length
aribute.

3. To modify the user/UserList widget, add or change these aributes and values:
a. To modify the time period considered for displaying users, set the activity_time_period aribute.

- past_day
- past_week
- past_month
- past_year
- any_time

This example code includes only users active in the past week.
<rn:widget path="user/UserList" activity_time_period="past_week" content_display_type="table_view"
 avatar_size="small"/>

b. To change the size of the avatar displayed, modify the avatar_size aribute.
- none
- small
- medium
- large

c. To set the format the content is displayed in, modify the content_display_type aribute.
- table_view
- list_view

d. To set which content is listed in the results, add the content_type aribute.
- questions
- comments
- best_answers

This example code includes a list of users active in the comments.
<rn:widget path="user/UserList" content_type="comments" content_display_type="table_view"
 avatar_size="small"/>

e. To set the maximum number of users shown in the list, add the max_user_count aribute.
f. To remove the avatar from the list, se the show_avatar aribute to false.

4. To modify the user/RecentlyActiveUsers widget, add or change these aributes and values:
a. To change the size of the avatar displayed, modify the avatar_size aribute.

- none
- small
- medium
- large

b. To set the format the content is displayed in, modify the content_display_type aribute.
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- grid_view
- list_view

c. To change the date format, modify the last_active_date_format aribute.
- full_textual (example January 1, 2000)
- short_textual (example Jan 1, 2000)
- numeric (example 1/1/2000)

d. To modify the time period considered for displaying users, set the show_users_active_in aribute.
- past_day
- past_week
- past_month

e. To determine which information shows for each user when the content is rendered as a list, set the
specify_list_view_metadata aribute with at least one of these values:

- user_avatar
- display_name
- last_active
- default: user_avatar, display_name, last_active

f. To change the maximum number of users displayed, set the max_user_count aribute.
5. To modify the utils/TwierPosts widget, add or change these aributes and values:

a. To set the required aribute fetch_tweets_using, add one of these values:
- account
- hashtag
- search_query

b. To display a specic number of tweets, add the data_tweet_limit aribute and set the value between 1 and
20.

c. To set the Twier account used to fetch tweets, add a value to the twier_account aribute.
Your code will look something like this:
<rn:widget path="utils/TwitterPosts" twitter_account="OracleServCloud"/>

Chaing on the Customer Portal  

Overview of Chat on the Customer Portal  
When Chat is enabled on your site, the Contact Us sidebar on the Results and Answer and Discussion Details pages
automatically includes a Live Chat link.

Occasionally, your customers may not nd the information they are looking for on your support site or need an answer
more quickly than a typical email response.

When a customer clicks a Chat link on your customer portal, the Live Help page opens and displays a small chat request
form. After the request is submied, the Chat page opens indicating the customer’s position in the queue. After an
agent accepts the chat request, the Chat page provides a place for the customer to post messages to the agent, and
displays a transcript of the chat session.

The Live Help page is where your customers submit a request for a chat session. After the request has been submied,
the Chat page opens and the customer can begin chaing with an available agent. The Live Help page is opened when
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customers click the Live Chat navigation link in the Contact Us sidebar or any other Chat link that may have been added
to your customer portal.

The default Live Help page displays the customer’s rst and last names and email address if the customer is logged in. If
the customer is not yet logged in, the elds are blank waiting for customer input. If you have incident custom elds with
chat visibility, those elds are displayed on the default Live Help page as well, with required custom elds noted by a red
asterisk. The page also contains a Submit buon, a chat status message, and the chat hours listing.

Change the Live Help Page Message Bases  
You can modify the Live Help page labels and headings.

1. Open /views/pages/chat/chat_launch.php.
2. To change the Live Help heading, locate <h1>#rn:msg:LIVE_HELP_HDG#</h1> and enter the new heading between

the <h1> and </h1> tags.
3. To change the Chat subheading, locate <span

class="rn_ChatLaunchFormHeader">#rn:msg:CHAT_MEMBER_OUR_SUPPORT_TEAM_LBL#</span> and replace the message
base with your replacement heading.
<span class="rn_ChatLaunchFormHeader">Talk to someone on our support team
 right now!</span>

4. To change the Chat Support available message, locate <rn:widget path="chat/ChatStatus"/> and add the
label_chat_available aribute to the widget.
<rn:widget path="chat/ChatStatus"
 label_chat_available="Agents are currently available." />

5. To remove elds from the Live Help page, locate this code.
<rn:widget path="input/FormInput" name="Incident.Subject" initial_focus="true"
 label_input="#rn:msg:SUBJECT_LBL#"/>
 <rn:condition config_check="COMMON:intl_nameorder == 1">
 <rn:widget path="input/FormInput" name="Contact.Name.Last"
 label_input="#rn:msg:LAST_NAME_LBL#" required="true"/>
 <rn:widget path="input/FormInput" name="Contact.Name.First"
 label_input="#rn:msg:FIRST_NAME_LBL#" required="true"/>
 <rn:condition_else/>
 <rn:widget path="input/FormInput" name="Contact.Name.First"
 label_input="#rn:msg:FIRST_NAME_LBL#" required="true"/>
 <rn:widget path="input/FormInput" name="Contact.Name.Last"
 label_input="#rn:msg:LAST_NAME_LBL#" required="true"/>
 </rn:condition>
 <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address"
 required="true" label_input="#rn:msg:EMAIL_ADDR_LBL#"/>
 <!-- optional fields -->
 <rn:widget path="input/CustomAllInput" table="Incident"
 chat_visible_only="true" always_show_mask="false" />

a. To remove the Subject eld, delete <rn:widget path="input/FormInput" name="Incident.Subject"
initial_focus="true" label_input="#rn:msg:SUBJECT_LBL#"/>.

b. To remove the Last Name eld and display only the rst name, delete <rn:widget path="input/FormInput"
name="Contact.Name.Last" label_input="#rn:msg:LAST_NAME_LBL#" required="true"/> from both condition
cases.

c. To remove the Email Address eld, delete <rn:widget path="input/FormInput"
name="Contact.Emails.PRIMARY.Address" required="true" label_input="#rn:msg:EMAIL_ADDR_LBL#"/>.

d. To remove incident custom elds, delete this code.
<!-- optional fields -->
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<rn:widget path="input/CustomAllInput" table="Incident"
 chat_visible_only="true" always_show_mask="false" />

6. Save the le.

Change Available Chat Hours  
You change chat hours on the administration interface. Those hours are listed on the Live Help page.

1. Double-click Interfaces in  Conguration > Site Conguration .
2. Click the interface you want to edit chat hours for.
3. Click Chat Hours.
4. To add a day, click Add and select a day.
5. To edit the start hour and minute or the end hour and minute for any day, click in the eld and enter the new

value.
6. Click Save.

Chat Page  
The Chat page opens after customers submit a chat request.

By default, the chat_landing.php le for the Chat page contains the include_chat page meta tag, which is set to true. If
you create additional pages that contain a chat application, you must include this meta tag and set it true in the page
le. When the include_chat tag is set to true, the page includes all the required JavaScript les for Chat.

Although the default Chat page includes multiple widgets, these widgets are necessary to create a usable Chat page.

• ChatServerConnect

• ChatTranscript

• ChatPostMessage

Congure the ChatServerConnect Widget  
You can change labels, icons, and other aributes of the ChatServerConnect widget.

1. Open one of these les:

◦ /views/pages/chat/chat_landing.php

◦ /views/pages/mobile/chat/chat_landing.php

2. Locate <rn:widget path="chat/ChatServerConnect"/>.
3. To change the loading icon, add the loading_icon_path aribute to the widget.

<rn:widget path="chat/ChatServerConnect" loading_icon_path="images/indicator_2.gif" />

4. To edit any of the default labels (shown in quotation marks), add the associated aribute and dene it with your
new label.

◦ label_connecting—“Please wait while we establish a connection to the Chat Server.”

◦ label_connection_fail—“There was a problem connecting to the Chat Server.”

◦ label_connection_success—“A connection to the Chat Server has been established successfully.”

◦ label_prevent_anonymous_chat—“One or more required contact elds are missing. Please review all
elds and re-submit the chat request.” This aribute applies only when you prevent anonymous chat
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requests by requiring one or more of the email, rst name, and last name elds (the email_required,
rst_name_required, or last_name_required aributes).

◦ label_terminate_session—“This action will terminate your current session. Do you want to continue?”

<rn:widget path="chat/ChatServerConnect" label_connecting="We are connecting
 to the chat server now." />

5. Save the le.

Disable New Message Notications  
You can disable the notication customers receive when the chat agent sends a new message and the transcript window
does not have focus.

1. Open /views/pages/chat/chat_landing.php.
2. Locate <rn:widget path="chat/ChatTranscript"/>.
3. Add the unread_messages_titlebar_enabled aribute to the widget and set it to false.

<rn:widget path="chat/ChatTranscript" unread_messages_titlebar_enabled="false" />

4. Save the le.

Replace the ChatTranscript Widget Icons  
You can replace the default icons by dening the path and le name for the replacement icon.

All default icons are in the /cp/customer/assets/themes/standard/images folder, but you can reference the path in
the widget aribute by entering images/<filename>.

1. Open chat_landing.php.
2. Find <rn:widget path="chat/ChatTranscript" />.
3. Add the appropriate aributes to the widget.

◦ Agent Message Icon—agent_message_icon_path

◦ Alert Icon—alert_icon_path

◦ End-user Message Icon—enduser_message_icon_path

◦ O the Record Icon—off_the_record_icon_path

<rn:widget path="chat/ChatTranscript" agent_message_icon_path="images/chat_agent_new.png" />

Edit the Chat Instructions Label  
You can change the message that is displayed to the customer.

1. Open /views/pages/chat/chat_landing.php.
2. Locate <rn:widget path="chat/ChatPostMessage"/>.
3. Add the label_send_instructions aribute to the ChatPostMessage widget.

<rn:widget path="chat/ChatPostMessage" label_send_instructions="Your new instructions for sending a
 message." />

4. Save the le.

Notify Customers of Incoming Messages  
You can bring the chat window to the top or ash the task bar buon to notify customers that a new response is
available.

This functionality is only available for customers using Internet Explorer.
1. Open /views/pages/chat/chat_landing.php.
2. Locate <rn:widget path="chat/ChatPostMessage"/>.
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3. Add the focus_on_incoming_messages aribute to the ChatPostMessage widget.
<rn:widget path="chat/ChatPostMessage" focus_on_incoming_messages="true" />

4. Save the le.

Add the ChatCobrowsePremium Widget  
You can let customers share their desktop with agents who are chaing with them.

Add the CoBrowsePremium Widget.
1. Do one of the following:

◦ Open /views/pages/chat/chat_landing.php.

◦ Open /views/pages/mobile/chat/chat_landing.php.

2. Locate this code.
<div id="rn_InChatButtonContainer">
 <rn:widget path="chat/ChatAttachFileButton"/>
 <rn:widget path="chat/ChatSendButton"/>

3. Add <rn:widget path="chat/ChatCobrowsePremium" />.
<div id="rn_InChatButtonContainer">
 <rn:widget path="chat/ChatAttachFileButton"/>
 <rn:widget path="chat/ChatSendButton"/>
 <rn:widget path="chat/ChatCobrowsePremium" />

4. Save the le.

Change the Chat Window Size  
The size of the Chat window is determined by the ChatLaunchBuon widget used on the Live Help page.

1. Open /views/pages/chat/chat_launch.php.
2. Locate this code.

<rn:condition config_check="MOD_VA_ENABLED == 0">
 <rn:widget path="chat/ChatLaunchButton" launch_width="390" launch_height="595"
 error_location="rn_ErrorLocation" add_params_to_url="q_id,pac,request_source,p,c,
 survey_send_id,survey_send_delay,survey_comp_id,survey_term_id,chat_data,
 survey_term_auth,survey_comp_auth"/>
<rn:condition_else/>
 <rn:widget path="chat/ChatLaunchButton" launch_width="390" launch_height="800"
 error_location="rn_ErrorLocation" add_params_to_url="q_id,pac,request_source,p,c,
 survey_send_id,survey_send_delay,survey_comp_id,survey_term_id,chat_data,
 survey_term_auth,survey_comp_auth,survey_send_auth,i_id"/>
</rn:condition>

3. Edit the launch_height and launch_width aributes to both instances of the ChatLaunchBuon widget.
...
<rn:widget path="chat/ChatLaunchButton" launch_width="250" launch_height="250"
...
<rn:condition_else/>
 <rn:widget path="chat/ChatLaunchButton" launch_width="250" launch_height="500"
...

4. Save the le.

Change the Answer Window Size  
You can control the size of the window that opens when the Search buon is clicked.

1. Open /views/pages/chat/chat_landing.php.
2. Locate <rn:widget path="chat/ChatQueueSearch" popup_window="true"/>.
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3. Add the following aributes and set their percentage value.
a. popup_window_height_percent (default 42 percent).
b. popup_window_width_percent (default 30 percent).

<rn:widget path="chat/ChatQueueSearch" popup_window="true"
 popup_window_height_percent="75"
 popup_window_width_percent="75" />

4. Save the le.

Congure Chaing O the Record  
The default Chat page contains a buon that customers can click to send an o-the-record message.

Any information the customer types in the O the Record Message dialog will not appear on the Messages tab of the
incident created from the chat session. Instead, the incident will show “Message Removed.” Text that is submied o-
the-record is displayed with a dierent color and icon in the chat transcript window.

1. Open the appropriate chat landing le.

◦ /views/pages/chat/chat_landing.php

◦ /vies/pages/mobile/chat/chat_landing.php
2. To set all chat posts o the record, edit the ChatPostMessage code to add the all_posts_off_the_record

aribute.
<rn:widget path="chat/ChatPostMessage" all_posts_off_the_record="true" />

3. To remove the o-the-record chat option, delete these two lines of code.

◦ <rn:widget path="chat/ChatOffTheRecordDialog"/>

◦ <rn:widget path="chat/ChatOffTheRecordButton"/>

4. Save the le.

Remove the Search Field from the Chat Page  
You can delete the search eld from the Chat page.

1. Open /views/pages/chat/chat_landing.php.
2. Delete this code.

<div id="rn_ChatQueueSearchContainer">
 <rn:widget path="chat/ChatQueueSearch" popup_window="true"/>
</div>

3. Save the le.

Remove Virtual Assistant Widgets  
If your customer portal is not integrated with Oracle RightNow Virtual Assistant Cloud Service, you should remove the
Virtual Assitant widgets.

The reference implementation default Chat page includes these virtual assistant widgets: VirtualAssistantAvatar,
VirtualAssistantBanner, VirtualAssistantSimilarMatches, and VirtualAssistantFeedback.

1. Open /views/pages/chat/chat_landing.php.
2. Delete these two sections of code.

<div id="rn_VirtualAssistantContainer">
 <rn:widget path="chat/VirtualAssistantAvatar"/>
 <rn:widget path="chat/VirtualAssistantBanner"/>
</div>

<rn:widget path="chat/VirtualAssistantSimilarMatches"/>
<rn:widget path="chat/VirtualAssistantFeedback"/>
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3. Save the le.

Add a Chat Link a Customer Portal Page  
This example adds a chat link to the Support Home page.

1. Open /views/pages/home.php.
2. Locate <h2 class="rn_ScreenReaderOnly">#rn:msg:SEARCH_RESULTS_CMD#</h2>.
3. Add <rn:widget path="chat/ConditionalChatLink" />.

<h2 class="rn_ScreenReaderOnly">#rn:msg:SEARCH_RESULTS_CMD#</h2>
<rn:widget path="chat/ConditionalChatLink" />

4. Save the le.

Congure the ConditionalChatLink Widget  
There are a number of aribute you can set for the ConditionalChatLink widget.

1. Open the page to edit.

◦ Open the page that includes the ContactUs widget where you want to congure conditional chat.

◦ Open the page where you’ve added the ConditionalChatLink widget.

2. To detect an incident ID and pass it through the URL for the chat agent, add the auto_detect_incident aribute
to the widget and set its value to true.
<rn:widget path="utils/ContactUs" auto_detect_incident="true" />

3. To change the Launch page that opens when customers click the chat link, add the chat_login_page aribute
and set its value to the new page.
<rn:widget path="utils/ContactUs"
 chat_login_page="/app/chat/chat_launch_alternate1" />

4. To hide the chat so it appears on your customer portal only when agents are available, add the
hide_on_unavailable aribute and set its value to true.
<rn:widget path="utils/ContactUs" hide_on_unavailable="true" />

5. To consider information entered by customers after they’ve been pre-routed, enabling routing rules to check
the values of customer elds and re-route the request accordingly, add the ignore_preroute aribute and set it
to true.
<rn:widget path="utils/ContactUs" ignore_preroute="true" />

Note:  The ignore_preroute aribute should be enabled only when necessary for achieving a specic
business goal. The agent availability detection and pre-routing functions occur before routing rules
are applied. As a result, when the ignore_preroute aribute is enabled, customers may be routed to
a dierent queue than the one originally determined by agent availability, even a queue for which no
agent is immediately available. This can conict with the indication of availability expressed by the
widget itself, leading to customer confusion.

6. To open the Chat Launch page in a new window, add the open_in_new_window aribute, set it to true, and then
dene the size with the chat_login_page_height and chat_login_page_width aributes.
<rn:widget path="utils/ContactUs" open_in_new_window="true"
 chat_login_page_height="500" chat_login_page_width="500" />
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7. Save the page.

Add the Syndicated ConditionalChatLink Widget  
You can add a chat link to an external page using the syndicated ConditionalChatLink widget.

Your prole must have WebDAV permission enabled, and you must log in with your Oracle Service Cloud user name and
password.

1. Enter hps://<your_site>/ci/tags/syndicated_widgets/standard/ConditionalChatLink to open the page
for the syndicated ConditionalChatLink widget.

2. In Congure Widget, modify the widget aributes for your organization’s needs.
3. To preview your changes, click Apply.
4. Modify the widget’s appearance by editing its CSS le, which is /cp/customer/assets/css/

syndicated_widgets/standard/ConditionalChatLink.css.
5. Click Select Text and copy the code.
6. Open the source code for the web page you want to add the widget to.
7. Paste the code into your page le just before the closing </body> tag.

Even if you plan to use multiple syndicated widgets on the page, you need to paste this code only once.
8. In the generated code, click the second Select Text buon and copy the code that denes the widget.
9. Paste the copied code just before the closing </body> tag.

10. Click the third Select Text buon, copy the code, and paste it in the page code where you want the widget to
appear.

11. Save the page.

Related Topics
• How You Access the Engagement Engine Editor from Service Cloud

• Engagement Engine Cloud Services Commonly Deployed Rules

Congure the Syndicated ConditionalChatLink Widget  
There are various options for conguring the syndicated ConditionalChatLink widget.

1. Select one or more options to congure.
◦ To direct customers to a page other than the Live Help page, enter the page name in the eld for the

chat_login_page aribute.
◦ To specify a product, enter the product ID number in the eld for the p aribute.

◦ To specify a category, enter the category ID number in the eld for the c aribute.

◦ To specify custom elds, enter one or more key-value pairs in the eld for the custom_fields aribute.
The key is the custom eld ID and the value is the value of the custom eld.

◦ To consider customer data when routing to a chat session, select the Enabled check box for the
ignore_preroute aribute.

Oering Customers a Chat Session  
You can oer customers a chat session when it appears they are not nding the information they are looking for.
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You can proactively oer a chat session from your customer portal pages as well as from any external page on your
website.

These events occur when a customer accepts a chat oer through either the ProactiveChat widget in the /cp/core/
widgets/standard/chat folder or the syndicated ProactiveChat widget.

• Before the chat is oered to the customer, the chat session routing rules determine what queue the chat
request will be directed to based on products, categories, custom elds, and other rule conditions.

• When the customer accepts the chat request, the Chat page that opens contains any incident custom elds that
have chat visibility.

• If the customer changes any of the information on the Chat page, that information is passed to the agent on
the chat session workspace. The rules engine does not run again. As a result, the customer may change a eld
that would have triggered the chat being assigned to a dierent queue, but because rules are not run on the
updated Chat page, the original queue assignment does not change.

We recommend that you do not add any elds to the Chat page that would result in a queue reassignment if the
customer edits that eld since reassignment does not occur with either the standard or syndicated widget. If you want
to display a dierent page to customers who enter a chat session through a proactive chat oer, you can create a
custom Chat Login page. After you create the custom page, change the chat_login_page aribute for the widget to
specify the custom page.

If you want to place the ProactiveChat widget on the /answers/list.php page, place it within the container dened
by <rn:condition url_parameter_check="kw != null">. Then when a search is performed while viewing all published
answers, the page is loaded with the ProactiveChat widget in place. Otherwise, it may not appear due to the page
refresh that occurs when a search term is entered.

Chat sessions are not oered in these situations.

• If the customer’s browser does not accept cookies, no chat is oered during the customer session.

• If the widget looks for a chat queue ten times without nding one, no chat is oered on that page.

• If a chat is oered (whether or not it is accepted), a cookie is set and no more chat oers are made during the
current customer session.

• If a chat is oered and the customer refuses, a cookie is set and no more chat oers are made for 30 days.

Reports for the ProactiveChat Widget  
There are two standard reports available for the ProactiveChat widget.

The standard reports available can be found in the Reports explorer Public Reports/Service/Chat Reports/Proactive
Chat.

• Proactive Chat Oer Statistics—Shows the number of site visits, proactive chat invitations, and accepted,
declined, refused, and ignored chat invitations.

• Proactive Chat Summary Statistics—Shows the number of chat requests resulting from a proactive chat
invitation and the number of chat sessions that were deected, abandoned, and accepted (with and without
agent interaction).

Add the ProactiveChat Widget to a Page  
This example adds the ProactiveChat widget to the results page.

Chat must be enabled and agents must be available before a chat will be oered to a customer. The customer’s browser
must be congured to accept cookies.

1248



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

The default code for the ProactiveChat widget will not trigger a chat oer until you add an aribute that denes the
trigger for the oer. You must add at least one of the following aributes to the code: seconds, searches, or profile_
aributes.

1. Open /views/pages/results.php.
2. Locate <rn:widget path="reports/Paginator" />.
3. Add the ProactiveChat widget.

<rn:widget path="reports/Paginator" />
<rn:widget path="chat/ProactiveChat" />

a. To trigger the chat oer based on the customer’s inactive time on the page, add the seconds aribute to
the code.
<rn:widget path="chat/ProactiveChat" seconds="60" />

b. To trigger the chat oer based on the number of searches the customer conducted, add the searches
aribute to the code.

<rn:widget path="chat/ProactiveChat" searches="3" />

4. Save the le.

Trigger Chat Oers  
When one of the required aributes has been met, an AJAX request is made to the server, which sends back the number
of available agents and the minimum wait time.

You must dene at least one of these aributes before the chat oer will be triggered: seconds, searches, and profile_.
1. To oer chat based on page time, add the seconds aribute.

<rn:widget path="chat/ProactiveChat" seconds="60" />

2. To oer chat based on number of searches, add the searches aribute.
<rn:widget path="chat/ProactiveChat" searches="3" />

3. To oer a chat based on customer prole information, dene the profile_item, profile_operator, and
profile_value aributes.
<rn:widget path="chat/ProactiveChat" profile_item="org_id"
 profile_operator="equals" profile_value="81945" />

The following list includes all the prole items you can use as conditions for oering chats to customers.

◦ slac—The number of chat incidents the customer’s SLA allows.

◦ slai—The number of self-service incidents the customer’s SLA allows.

◦ web_access—The customer’s SLA allows self-service.

◦ org_id—The ID of the organization associated with the customer.

◦ o_lvlN—The ID of the organization’s sublevel, if the organization has subsidiaries, where N is the
organization level.

Any of the following operators are valid for dening prole items.

◦ Equals

◦ Less than or equals

◦ Greater than or equals

◦ Not equal

◦ Less than
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◦ Greater than

4. To oer a chat based on an event, you must use custom code:
a. Create an event called evt_customProactiveInitialization.
b. Set the initiate_by_event aribute of the ProactiveChat widget to true.

If your organization requires SLAs in order for customers to chat with agents, you’ll want to verify that the customer has
an SLA with available chat incidents before a chat session is oered. The prole aributes of the ProactiveChat widget
can do that for you.

Add the prole_item, prole_operator, and prole_value aributes to the code for the ProactiveChat widget.

Your edited code will resemble the following.

<rn:widget path="chat/ProactiveChat" seconds="30" profile_item="slac"
 profile_operator="greater than" profile_value="0" />

Congure the ProactiveChat Widget  
A number of aributes are available to customize and congure the ProactiveChat widget.

Dene the seconds, searches, or profile_ aributes in order to Trigger Chat Oers.
1. To edit the chat invitation message, add the label_chat_question aribute.

<rn:widget path="chat/ProactiveChat" seconds="30"
 label_chat_question="Staff members are available now.
 Would you like to chat with someone?" />

2. To change the Chat Login page, add the chat_login_page aribute.
<rn:widget path="chat/ProactiveChat" seconds="30"
 chat_login_page="/app/chat/alternate_chat_launch_page" />

3. To change the size of the chat login window, add the chat_login_page_height and chat_login_page_width
aributes.
<rn:widget path="chat/ProactiveChat" seconds="30" chat_login_page_height="500"
 chat_login_page_width="600" />

4. To open the Chat Login page in the same window, add the open_in_new_window aribute.
<rn:widget path="chat/ProactiveChat" seconds="30" open_in_new_window="false" />

5. To dene the maximum wait time, add the wait_threshold aribute.
<rn:widget path="chat/ProactiveChat" seconds="30" wait_threshold="60" />

6. To dene the minimum number of agents, add the min_agents_avail aribute.
<rn:widget path="chat/ProactiveChat" seconds="30" min_agents_avail="2" />

Add the Syndicated ProactiveChat Widget to a Web Page  
You can place the syndicated ProactiveChat widget on external sites, instead of being restricted to just customer portal
pages.

Your prole must have WebDAV permission enabled, and you must log in with your user name and password.
1. Open hps://<your_site>/ci/tags/syndicated_widgets/standard/ProactiveChat.
2. Scroll down to the Congure Widget section and begin modifying the widget aributes as you choose.
3. To preview your changes, click Apply.
4. Click the top Select Text buon and copy the code.
5. Open the web page you want to add the widget to.
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6. Paste the code into your page le just before the closing </body> tag.
Even if you plan to use multiple syndicated widgets on the page, you need to paste this code only once.

7. In the generated code, click the second Select Text buon and copy the code that denes the widget.
8. Paste the copied code just below the code you pasted, earlier.
9. Add <div_id="myDiv"></div> to the page code where you want the widget to appear.

10. Save the page.

Related Topics
• How You Access the Engagement Engine Editor from Service Cloud

• Engagement Engine Cloud Services Commonly Deployed Rules

Trigger Syndicated Chat Oers  
You can dene additional conditions that must be met before a chat is oered.

You must set the seconds aribute before a chat oer will be triggered. You could also create custom rules that trigger
the chat oer.

The syndicated ProactiveChat widget opens a chat invitation to your customers after they spend a specied amount of
time on the page where you placed the widget. The default code for the syndicated ProactiveChat widget will not trigger
a chat oer because the default values for the seconds aribute is 0.

1. Open the syndicated ProactiveChat widget page.
2. To trigger chat oers based on page time, enter a value in the eld for the seconds aribute.
3. To dene the minimum number of agents, enter a value in the eld for the min_agents_avail aribute.
4. To dene the maximum wait time, enter a value in the eld for the wait_threshold aribute.

Congure the Syndicated ProactiveChat Widget  
A number of aributes are available to customize and congure the syndicated ProactiveChat widget.

1. Open the Syndicated ProactiveChat Widget page.
2. To dene a default product, enter the product ID in the eld for the p aribute.
3. To dene a default category, enter the category ID in the eld for the c aribute.
4. To change the Chat Login page, enter a value in the eld for the chat_login_page aribute.
5. To open the Chat Login page in the same window, clear the Enabled check box in the open_in_new_window

aribute.
6. To change the size of the chat login window, enter new height and width aribute values.

a. Enter the new height of the window, in pixels, in the eld for the chat_login_page_height aribute.
b. Enter the new width of the window, in pixels, in the eld for the chat_login_page_width aribute.

7. To replace default images, reference new image les in /cp/customer/assets/images/.
a. To replace the avatar image, enter the image le path in the eld for the avatar_image aribute.
b. To replace the logo image, enter the image le path in the eld for the logo_image aribute.
c. Leave the elds blank if you do not want to display any images.

8. To edit chat invitation messages, edit the label aribute.
a. To edit the Yes buon, enter the new label in the eld for the label_accept_button aribute.
b. To edit the No buon, enter the new label in the eld for the label_reject_button aribute.
c. To edit the label for the chat refusal check box, enter the new label in the eld for the

label_refuse_checkbox aribute.
9. To edit alternative (alt) text for images.

a. Enter the new label for the avatar image in the eld for the label_avatar_image aribute.
b. Enter text in the corporate logo image eld for the label_logo_image aribute.
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10. To edit the dialog header and title bar, add your own data.
a. For the header label, enter the new label in the eld for the label_dialog_header aribute.
b. For the title bar, enter the new label in the eld for the label_title aribute.

11. To edit the chat invitation, enter a new chat invitation message in the eld for the label_question aribute.
12. To edit the div element, enter a new name for the div element in the eld for the div_id aribute.

<div id="newDiv"></div>

13. To edit the instance ID, replace the “0” in “spac_0” in the instance_id aribute with another value for each
widget you add to the page. If you have more than one syndicated ProactiveChat widget on a page, you must
have unique ID values for each of them. The default value is spac_0.

14. To change the dialog to modal, select the Enabled check box for the modal aribute.

Custom Rules for Syndicated ProactiveChat  
You can dene custom rules that specify other conditions for triggering a chat oer.

You may want to oer a chat to customers who have a certain dollar value or a specic type of product in their shopping
cart.

The syndicated ProactiveChat widget includes two JavaScript API functions.

• The chatAvailability() function, for checking agent availability

• The oerChat() function, for oering a chat invitation

You can call these functions from your web pages on a specic instance of the ProactiveChat widget. This can be done
either through an event or with a direct method call. The custom code to trigger a chat oer must appear on the same
page where you place the syndicated ProactiveChat widget.

Expose the API Functions  
You can request agent availability, oer a chat session using the oerChat() function, and oer a chat using an event.

1. Open the web page you want to expose the API functions.
2. Add this code for each widget instance.

<script type="text/javascript">
 RightNow.Client.Controller.addComponent(
 {
 modal: true,
 instance_id: "spac_0",
 div_id: "myDiv",
 seconds: 0,
 module: "ProactiveChat",
 type: 2
 },
 "http://[your_site]/ci/wsf/get"
 );
</script>

Use the chatAvailability() Function  
You can use this function to check the queue id that is currently assigned to the chat instance, the number of agents
available, and the current wait time.

Expose the API Functions.

The chatAvailability() function of the syndicated ProactiveChat widget requests agent availability. In this example, the
chatAvail() function calls the chatAvailability() function on the spac_0 instance of the syndicated ProactiveChat widget.
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The callback method, chatDataAvail, displays alerts for the queue ID, agent availability, and wait time data of the result
argument.

1. On the web page containing the widget, add this code to dene a function that calls chatAvailability() and to
dene a callback method.
function chatAvail(){
 spac_0.chatAvailability(chatDataAvail);
};
function chatDataAvail(result){
 alert("q_id "+result.queueId);
 alert("agent_avail "+result.availableAgentSessions);
 alert("wait_time "+result.expectedWaitSeconds);
};

2. Make sure that your code calls the function that makes the call to chatAvailability(), which in the example is the
chatAvail() function.

Use the oerChat() Function  
You can use the oerChat() function to oer a chat session if its Boolean argument is true.

Expose the API Functions.

The oerChat() function of the syndicated ProactiveChat widget lets you oer a chat to a user. In this example, the
chatAvail() function calls the chatAvailability() function on the spac_0 instance of the syndicated ProactiveChat widget.
The callback method, chatDataAvail, examines the result argument to verify that more than one agent is available and, if
so, calls the oerChat() function to oer a chat to the user.

1. On the web page containing the widget, add this code to dene a function that calls chatAvailability() and to
dene a callback method that calls the oerChat() function.
function chatAvail(){
 spac_0.chatAvailability(chatDataAvail);
};
function chatDataAvail(result){
 if(result.availableAgentSessions > 0) {
 alert("offering a chat now");
 spac_0.offerChat(check);
 }
};

2. On the web page, make sure that your code calls the function that makes the call to chatAvailability(), which in
the example is the chatAvail() function.

Request Chat Availability Using an Event  
You can request chat availability through an event.

The code must rst subscribe to the evt_chatAvailabilityResponse event and then re an evt_chatAvailabilityRequest
event.

1. Add this code to the web page containing the syndicated ProactiveChat widget.
function chatAvailEvent(){
 RightNow.Client.Event.evt_chatAvailabilityResponse.unsubscribe(onDataReady);
 RightNow.Client.Event.evt_chatAvailabilityResponse.subscribe(onDataReady);
 RightNow.Client.Event.evt_chatAvailabilityRequest.fire();
};

2. Add code to call the function that requests chat availability, which in the example is chatAvailEvent().

Oer a Chat Using an Event  
You can oer a chat session by ring an evt_chatOerRequest event.
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The checkAvailability parameter of the evt_chatOerRequest event determines whether the request rst checks for
agent availability. If the argument is set to true, the evt_chatAvailabilityResponse event is rst red, which determines
whether agents are available. If the argument is set to false, a chat is oered immediately.

1. Add this code to the web page containing the syndicated ProactiveChat widget.
function offerChatEvent(){
 RightNow.Client.Event.evt_chatOfferRequest.fire({data:{checkAvailability: true}, id: "spac_0"});
};

2. Add code to call the function that oers the chat, which in this example is oerChatEvent().

Community Self Service Overview  

Overview of Community Self Service  
Peer-to-peer support has become an increasingly important part of web self-service customer support.

Your customers expect a support site that integrates ocial company knowledge with solutions from other customers.

Note:  This section discusses the Community Self Service feature integrated with Customer Portal Framework
Version 3.3 in the August 2015 release. If you are looking for information about conguring Oracle RightNow
Social Experience communities, go to Communities on the Customer Portal in the May 2015 documentation.

Your customers have always been able to search for an answer in your knowledge base and ask a question of your
customer support agents. Community Self Service adds an extra layer of information for your customers. When they
seek an answer to their questions, the Customer Portal returns community content in addition to your published
answers. And when they want to ask a question, they now have the option of asking for help from other customers.
Even SmartAssistant returns community discussions as well as published answers.

Gaining crowd knowledge from other users means that your customers have a powerful new self-service channel that
can reduce the number of incidents your customer support agents need to resolve.

Community Self Service Users  
There are several dierent kinds of users in Community Self Service.

Community users have a Public Prole page associated with their account that includes information about their recent
public activity within the Community, including their questions, comments, and answer ratings.

The Community feature prevents anonymous interactions. Unless Community users have a contact record in your
database, they can read content but they may not comment, ag information, or forward content. To allow Community
interaction, contact records must be extended to include a Community user record that includes display name and
avatar. Customers who have a contact record but do not yet have a Community record will be prompted to enter a
display name prior to interacting on the Community. Customers who do not have a contact record will be prompted to
create both a contact record and a Community record.
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User Types Functionality

Unregistered Community users • Can browse and search the knowledge base.

Registered Community users When we talk about Community users, we’re generally referring to registered Community users.

• Can browse and search the knowledge base.

• Can ask questions.

• Can provide support to other customers.

Moderators You can congure moderation on your customer portal to create dierent types of moderators with
dierent privileges and access levels

• Can interact with user-generated content and Community users.

• Can edit, move, and remove content.

• Can manage customers who disrupt the Community.

• Can be a sta member or a customer.

Agents Agents who ask or answer questions on the Community will need a Community account in addition to
their sta member account on the agent desktop.

• Can monitor the Community for unanswered questions and respond where appropriate.

Analysts • Can review the analytics generated by the Community.

• Can review reports on the agent desktop.

Administrators • Congures the Community Self Service feature on the agent desktop.

• Can update user roles and permissions.

• Can extend or create new reports.

• Can modify conguration seings.

Customer Portal developers • Can develop, launch, and maintain your customer portal, including your Community

Community Self Service Actions  
There are a number of actions available for dierent users within a discussion.

These actions are available within discussions.

• Questions/Discussions—A question in the community is similar to a Service Cloud incident or a discussion in
a forum. At a minimum, a question has a title and body, and it may have additional custom elds. Questions
cannot have image or le aachments.

◦ Asking a question/creating a new discussion—Community users can create new questions, which consist
of a title and body text. You may want to extend a question with custom aributes.

• Associating a product or category to questions—Community users can associate their questions with a product
or category.
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• Selecting best answers—Moderator or the question’s author can select the comment that best answered
the question. Best answers are displayed near the original question so other users can easily nd them. By
default, the Support Home page displays only the recent community discussions that have a best answer. Child
comments can also be marked as the best answer.

• Editing questions—Original authors can edit their own questions, and moderators can edit questions from
community users.

• Deleting questions—Original authors can delete their own questions. When comments are associated with a
question that is deleted, the comments are also deleted.

• Comments/Replies—Community users can respond to the original question with their feedback. The reply,
or comment, is a single eld that cannot contain image or le aachments, but it can contain hyperlinks. If
the question includes many replies, the question is paginated with newer comments at the end. Community
users can edit or delete their own comments. Users can also subscribe to a question or comment in order to be
notied when someone has posted new content to the discussion.

• Ratings—Community users can rate replies to questions by upvoting the comments they like. They can also
upvote questions to indicate that they also have a question similar to the one posed by the question’s author.

Community Public Prole Page  
The Public Prole page allows users to manage their public prole.

This page also allows users to manage what information displays to the community when they post a question or
comment and displays information about their recent activity in the community.

Community users can click their display name in the upper right corner of the customer portal window to view their
account information, account overview, support history, and account seings.

Community Access Control  
Access control denes the circumstances in which dierent users can perform actions.

Depending on their permissions, community users can perform a wide variety of actions on community content and
users. Using access control, you can set up permissions. Although the Community Self Service feature allows countless
combinations of its elements to oer you maximum exibility in assigning permissions, it also includes basic default
access control components that should meet most business needs.

For example, you might set permissions so that your community users are restricted to editing and deleting their own
content, while moderators are able to edit and delete content from any user, but only for specic products.

Community Moderation  
You can assign moderator privileges to your sta and trusted community users.

Moderators can interact with other users and with user-generated content by editing, moving, and removing it. They
can manage users who disrupt your community. Moderation privileges are congurable so your organization can have
multiple levels of moderation.
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Moderators are responsible for managing inappropriate content and users, organizing content and keeping it on track,
and keeping a site active. Moderators can use the moderation dashboards to identify agged content, review, and
suspend or restore it. They can suspend disruptive community members or delete their accounts entirely. They can also
edit and lock discussions from within the discussion.

Search for Community Discussions  
Users can search for specic discussions and lter on product (or category), age, and whether the discussion includes a
best answer.

1. On the Community page, to search by general search terms, enter search terms in the Ask a Question eld.
2. Apply lters as needed.

◦ To lter by product, click Filter by Product and select a product.

◦ To lter by age, click the Filter by Age and select one of the options: Last Day, Last Week, Last Month, or
Last Year.

◦ To lter by discussions that have a best answer, click Filter by Best Answer and select Yes.

3. Click Search.

Ask a Question to the Community  
This process outlines the steps community users take to post a question to the community.

By default, you will receive an email whenever a comment is posted to your question.
1. Click Ask a Question.
2. Click Ask Our Community.
3. Enter the subject in the Subject eld.
4. Enter more information about your question in the Question eld.
5. To select a product, click Product and select the product or subproduct associated with your question.
6. Click Post Your Question.

Overview of Aaching Files in Community Self Service  
You can aachment documents, templates, and snippets to incidents, answers, and community questions and
comments.

Aachments can contain malicious code (malware) or data. All incoming aachments are put through an Abuse
Detection System (ADS) and scanned for malware. Questionable aachments or aachments that fail the scan are
rejected.

CAUTION:  You should always consider the possibility that aackers could evade detection.

End users can aach les to community questions and comments. Clicking on the le link on the Discussion page will
force the user to download the aachment to their local system. The le URL is associated to the current user’s session.
This means a user cannot forward the le URL to other users.
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Users must have the appropriate read or write permissions in order to view a le aachment or to aach a le. The
system generates an error page for users trying to view an aachment without the appropriate permissions. You controll
these permissions using Access Control.

There is a server-controlled whitelist of allowed le extensions. This whitelist is applied using the widget aribute.
Aachments are forced to be downloaded. You cannot choose to have them open into a browser window or tab. For
additional security, if the le name contains unreliable characters, the le name is sanitized to a harmless string.

Add Comments to a Discussion  
This process outlines the steps community users take to add comments to discussions.

1. Open a discussion.

◦ To add a comment to the question, enter your comment in the Add a New Comment eld.

◦ To reply to another comment, click Reply and enter your response in the Reply to this Comment eld.

2. Click Post Comment.

Flag and Rate Questions and Comments  
This process outlines the steps community users take to ag and rate questions and comments.

1. From the community question or comment, select the feedback.

◦ To ag a question or comment as inappropriate, click the Flag link.

◦ To indicate that you have the same question as the one being asked, click the up arrow.

◦ To indicate that you agree with a comment that has been made, click the up arrow to the right of the
Reply and Share links.

Note:  Users cannot upvote their own question or comment.

Share Community Discussions  
This process outlines the steps community users take to email a discussion or share a link to a discussion.

1. To email a discussion:
a. Click Email This Page.
b. Enter an email address in the Recipient Email eld.
c. Click Send Email.

2. To share a discussion on social media:
a. Click Share.
b. Select the social media site where you want to share the discussion.

3. To share a link to a comment within a discussion:
a. Click Share.
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Edit Your Community Questions  
This process outlines the steps community users take to edit their questions.

1. Click Edit.
2. To edit the subject, enter new text or edit existing text in the Subject eld.
3. To edit the question, enter new text or edit existing text in the Question Body eld.
4. To change the product associated with the question, click the Product drop-down menu and select a dierent

product.
5. Click Save.

Delete Your Community Questions  
This process outlines the steps community users take to delete their questions.

1. Click Edit.
2. Click Delete This Question.
3. Click Yes.

Edit Your Community Comments  
This process outlines the steps community users take to edit their comments.

1. Click Edit.
2. To edit the comment, enter new text or edit existing text in the Edit This Comment eld.
3. Click Save.

Delete Your Community Comments  
This process outlines the steps community users take to delete your comments.

1. Click Edit.
2. Click Delete.
3. Click Yes.

Format Community Questions and Comments  
You can enter questions and comments using plain text or formaed text.

1. To mark text as bold, select the text and click B.
2. To mark text as italic, select the text and click I.
3. To create a bulleted list, select the paragraphs and click the bulleted list icon.
4. To create a hyperlink, select the link text and click the link icon.

a. Enter the URL where the link should point in the Links To eld.
b. Click OK.
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5. To view the text as plain-text markdown instead of the default rich text mode, click Advanced Mode.

Select the Best Answer to a Question  
This process outlines the steps community users take to identify and select the best answer to their question.

1. Click Mark as the Best Answer by Author.
2. To change your selection of the best answer, select a dierent best answer.
3. To remove your selection of best answer without selecting another best answer, click Unmark as Best Answer

by Author.

Search Questions from a User  
This process outlines the steps community users take to search for questions by a particular community user.

1. Click the avatar or user name of a community member to go to that member’s public page.
2. Enter a search term in the Search eld.
3. To remove the author lter on the Search Results page, click X.

Edit Your Community Prole  
This process outlines the steps community users take to edit their prole.

1. Click the drop-down menu on your display name in the upper right corner and select Public Prole.
2. Click Update.
3. To change your avatar, follow these steps.

a. Click Change Your Prole Picture.
b. To use the default picture (the rst leer of your user name), click Apply next to default picture.
c. To use your Gravatar prole picture, click Apply next to Gravatar.

Note:  Gravatar is a Globally Recognized Avatar, an image that appears besides your name on
the community as well as other social sites where you post or comment. You can register an
account at hps://www.gravatar.com and upload an avatar that is associated with your account.

d. Click Save Changes.
4. To change your user name, follow these steps.

a. Enter the new name in the Display Name eld.
b. Click Save Changes.

Conguring Your Community  

Overview of the Community Access Control  
Access Control lets you dene each user’s ability to interact with content on your community site.
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Access Control lets you dene what community users have access to in the community and is congured on the agent
desktop of Oracle Service Cloud. The Access Control home contains two links.

• View Active Access Control—displays the access controls currently available on your production site.

• View Pending Access Control Paths—displays the access control changes that have been made but not yet
deployed.

Access control paths oer a top-to-boom view of the access control elements and show the components that make up
role sets.

• roles

• permission sets

• permission set lters

• the user ownership constraint

The reference implementation includes default permission sets, roles, and role sets that should meet most of your
access control needs. The Community Self Service feature oers you maximum exibility in assigning permissions by
allowing countless combinations of its components.

Permissions are the most granular element of access control, and each permission allows a user the ability to perform
a single activity. More than forty permissions are available to allow users to view, create, edit, move, ag, and rate
questions and comments, as well as perform a variety of community moderation activities.

Permission sets are groups of permissions. The reference implementation includes six default permission sets to
address basic community user needs.

• view

• author

• ag

• rate

• moderation questions and comments

• select best answers

Other permission sets allow users to create, edit, and moderate user proles and delete community members.

Permission set lters and user ownership constraints restrict where on the community individual permissions and
permission sets apply. The reference implementation includes one default permission set lter, the Default Nowhere
Permission Set Filter, which is an empty lter that you can use to create additional lters.

Every user must have at least one role, and several default roles are included in the reference implementation. Roles
combine the permissions granted in the permission sets with the product or category lters of the permission set lters.

Because one person can have multiple roles, role sets are a combination of roles. Roles sets can then be assigned to
contacts in your knowledge base.

Community Role Sets  
Understanding the role set defaults can help you determine what changes you want to make.

Access control elements are stored in Community (default) and Custom folders. You cannot edit or delete any of the
Community access control elements or move them from the Community folder. Although you can create and move
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additional custom folders, subfolders, and access control elements, you cannot move any custom element or folder into
a Community folder.

The Customer Portal reference implementation includes six default role sets created to address a variety of business
needs. All community users automatically have three role sets assigned to their user prole: Everyone, Default
Community User, and Default Contact.

When sta members add contacts to your database and when new customers create accounts on the customer portal,
they automatically have these permissions. If you have existing customers that were created before you began using
the community self service feature, they are prompted to create a user prole (that is, add a display name) before
interacting on the community pages. The creation of a user prole then grants them the same default permissions that
all community users have.

• By default, all users have these permissions.

◦ View all questions and comments as well as the ags and ratings for all.

◦ View all community users.

◦ Create, ag, and rate questions and comments.

◦ Choose the best answer for their own questions.

◦ Delete any ags or ratings they have assigned.

◦ Edit their own questions and comments.

◦ Delete their own questions and comments.

◦ Create and edit their own user prole, including display name and avatar.

• Three additional role sets exist.

◦ Default Account

◦ Community Moderator—In addition to the permissions assigned to everyone, users with the this role set
can:

- Create, ag, and rate questions and comments for other users.
- Choose the best answer for a question.
- Delete ags and ratings for questions and comments from other users.
- Edit questions and comments from other users.
- Edit status and make rating adjustments for other users’ questions and comments.
- Delete questions and comments.
- Lock discussions.
- Work on the moderator interface.
- Edit a community user’s display name, avatar, and status.
- View contact information for a user.

◦ Community User Admin—Can view the moderator interface and create and delete community users.

Add Access Control to a Navigation Set  
Users need the Access Control item in their navigation set before they can congure access control.

1. Open Navigation Sets in  Conguration > Application Appearance .
2. Right-click the navigation set you want to edit and select Open.
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3. Select Conguration in the upper right column of the editor.
4. In the left column, expand  Components > Common  and select Access Control.
5. Click Add.
6. Click Save.

Add the Access Control Prole Permission  
This procedure lets sta members create and modify access controls for your community.

1. Double-click Proles in  Conguration > Sta Management .
2. Right-click the prole you want to edit and select Open.
3. Click Search.
4. Select a navigation set containing Access Control permission.
5. Click Permissions.
6. Select Access Control.
7. Click Contacts.
8. Select Access Control.
9. Click Save.

Set the Access Control Filter  
This process changes the lter from the default of products to categories.

You cannot lter by both products and categories.
1. Double-click Conguration Seings in  Conguration > Site Conguration .
2. Click (Select All).
3. Enter SSS_PERMISSION_BY_PRODUCTS in the Key eld and click Search.
4. Click Value, then click the drop-down menu and select No.
5. Click Save.

Create a Contact Workspace for Assigning Role Sets  
The standard contact workspace does not include the control for assigning role sets to a contact. Therefore, you must
rst create a custom contact workspace with the control.

1. Double-click Workspaces/Workows in  Conguration > Application Appearance .
2. Click Standard.
3. Right-click Contact and select Copy.
4. Enter the name for the new workspace in the Name eld.
5. Click OK.
6. Click Workspaces and Workows.
7. Right-click the copied workspace and select Open.
8. Right-click the tab on the far right of the tab set and select Add Tab After.
9. Name the New Tab.

a. Click the tab.
b. Click Design.
c. Click Text.
d. Select New Tab 1.
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e. Enter Role Sets View.
f. Press Enter.

10. Click Insert Control.
11. Drag the Role Sets View control to the new tab.
12. Click Save.

Assign Role Sets to a Contact  
Sta members whose proles include a custom contact workspace with the Role Set Views control can assign role sets
to existing contacts.

1. Double-click the name of the contact you want to edit in an open contact report.
2. Click Role Sets View.
3. Expand the Community and Custom folders.
4. Select any other role sets you want to assign to the user.
5. Click Save.

Search an Access Control Report  
If the report contains many entries, it may be easier to search than to scroll through the list looking for what you want.

1. Open the report you want to search and click Search.
2. Select lters that match your search criteria.
3. To search by name, enter the rst few leers of the element’s name followed by an asterisk or percent sign in

the Name Like eld.
4. Click Search.

Reset an Access Control Report  
After you’ve search the report using specic lters, you might want to return to the original search criteria.

1. Open the report you want to reset.
2. Click Reset.

Refresh an Access Control Report  
Sometimes after you’ve added or deleted items, you will need to refresh the report in order to reect your changes.

1. Open the report you want to refresh.
2. Click Refresh.

Community Permissions  
Permissions dene which users can interact with community content and user information, what kinds of interactions
are allowed, and where they have these permissions. You cannot customize an existing permission or add a new one.

1264



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

Permissions are dened to allow actions on information in the database, and the default permissions are set. More
than forty permissions exist to let community users view, create, edit, move, ag, and rate discussion content and user
information. Additional permissions include options for moderators.

The Permissions report, opened by double-clicking Access Control on the navigation pane and clicking Permissions,
displays a read-only list of all community permissions.

Note:  Although the Edit buon is active, you cannot edit individual permissions. And although the New
buon is active when Edit is selected, you cannot create permissions. Instead, the New buon opens the
Permission Set workspace.

When the Permissions report is open, you can search, reset the search parameters, and refresh the report using the
buons on the top left of the tab. You can sort the report on each of the column headings.

The Permission Data Conditions column lists the possible constraints for each permission. For example, the User Owned
constraint on the Edit Community User Avatar means that you can constrain the permission so that community users
with that permission can change only their own avatar.

The # Permission Sets link lets you drill down to view which permission sets include the selected permission. Drilling
down on the Edit Community User Avatar shows the two permission sets that use the permission.

The Access Control Path link lets you drill down to view all the paths of  Role Set > Role > Permission Set > Permission
Set Filters > Constraints  that use that specic permission.

Overview of Community Permission Sets  
The forty-four community permissions can be grouped into any combination of permission sets.

Six default permission sets are included in the reference implementation to address basic community user needs.

• Default Community User—Users can create and edit their own community user prole, including display name
and avatar.

• Default Community Viewer—Users have read-only access to community users, questions, comments, ratings,
and ags.

• Default Community Author—Users can create, ag, and rate questions and comments. Users also have
permission to change the content they have authored. They can edit and delete questions and comments,
delete ratings and ags for questions and comments, and select a best answer.

• Default Community Moderator—Moderators can choose a best answer, view the moderator-only elements
of the user interface, lock questions, and move comments. They can also delete questions and comments,
ags, and ratings, as well as edit questions and comments, rating adjustments, and status, and the question
interface.

• Default Community Moderator – Users—Moderators can edit a community user’s display name, avatar, and
status, view the moderator-only elements of the user interface, and view contact details for a community user.

• Default Community Admin – Users—Moderators can create and delete community users and view the
moderator-only elements of the user interface.

When you click Permission Sets in the ribbon of the Access Control window, the permissions sets report displays in the
default View Active mode.
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When you click the Edit buon in the ribbon, the permission sets report displays these columns.

• Created Time

• Created By

• Deployment Action

You can view the permissions included in the permission set by clicking the #Permissions Assigned link to display the
permissions. The Default Community User permission set, for example, contains four permissions. Notice that the drill-
down report title includes the Permission Set ID value (1 in this example) instead of the Permission Set name.

Create a Permission Set  
In addition to the six default permission sets included in the reference implementation, you can create custom
permission sets to more precisely dene the exact permissions you want to grant to your community users and
moderators.

1. Double-click Access Control.
2. Click Permissions Sets.
3. Click Edit.
4. Click New.
5. Select Permission Set.
6. Enter the permission set name in the Name eld using only leers, numbers, and underscores.
7. Enter a unique descriptive name for the permission set in the Labels eld.
8. To describe the permission set, enter information in the Descriptions eld.
9. To store the permission set in an existing subfolder rather than in the default Custom folder, click Search in the

Folder eld.
a. Select the folder name.
b. Click OK.

10. To create a new subfolder for storing the permission set, click Search in the Folder eld.
a. Right-click Custom and select New Folder.
b. Enter the folder name and press Enter.
c. Select the new folder.
d. Click OK.

11. Click the arrow next to the Community check box to expand the list of permissions.
12. Select the individual permissions you want the new permission set to include.
13. Click Save.

Deploy Access Control Changes

Copy a Permission Set  
It’s possible that a default or custom permission set is almost identical to the one you want to create. You can copy the
existing permission set so you can edit it and make your changes.

1. Click Edit.
2. Click Permission Sets.
3. Right-click the permission set you want and select  Copy > Permission Set .
4. To change the default name of the copied permission set, enter the new name in the Name eld.
5. Enter a new name for the permission set in the Labels eld.
6. Click Save.
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Edit a Permission Set  
You can edit any permission set in the Custom folder or its subfolders, but you cannot edit the default Community
permission sets.

1. Click Edit.
2. Click Permission Sets.
3. Right-click the permission set you want to edit and select  Open > Permission Set .
4. To edit the name, enter a new name in the Name eld.
5. To edit the label, enter a new label in the Labels eld.
6. Expand the Community permissions in the left column.
7. To add a permission, select its check box.

a. To add a constraint to the selected permission, select the Constrain By check box.
b. To remove a constraint from a permission, clear the Constrain By check box.

8. To remove a permission, clear its check box.
9. Click Save.

Delete a Permission Set  
You can delete any permission set in the Custom folder or its subfolders, but you cannot delete the default Community
permission sets. Nor can you delete a permission set that is used in a role.

1. Click Edit.
2. Click Permission Sets.
3. Right-click the permission set you want to delete and select  Delete > Permission Set .
4. Click Yes.

View Where Permissions are Used  
This process lets you determine where a permission set is in use.

1. Click Used In.
2. Click links to view:

◦ the number of permission sets in each role

◦ the assigned permission set lters

◦ the number of role sets using the permission set

◦ the access control path

Create a Permission Set Filter  
Permission set lters are used for permissions that have a product or category restraint.

1. Double-click Access Control.
2. Click Permissions Set Filters.
3. Click Edit.
4. Click New.
5. Select Permission Set Filter.
6. Enter the permission set lter name in the Name eld using only leers, numbers, and underscores.
7. Enter a descriptive name for the permission set lter in the Labels eld. You can use spaces and special

characters, but each custom permission set lter must have a unique label.
8. To describe the permission set lter, enter information in the Descriptions eld.
9. Select one or more products (or categories) in the left column.

10. Click Save.
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Copy a Permission Set Filter  
You can copy the default permission set lter or a custom lter to create a new lter.

1. Click Edit.
2. Click Permission Set Filters.
3. Right-click the lter you want and select  Copy > Permission Set Filter .
4. To change the default name of the copied permission set lter, enter the new name in the Name eld.
5. Enter a new name for the permission set lter in the Labels eld.
6. Click Save.

Delete a Permission Set Filter  
You can delete any permission set lter that is not being used in a role, but you cannot delete the default Nowhere
Permission Set lter.

1. Click Edit.
2. Click Permission Set Filters.
3. Right-click the lter you want to delete and select  Delete > Permission Set Filter .
4. Click Yes.

User-Owned Constraints  
Individual permissions and permission sets apply everywhere on the community unless they are constrained. Some
permissions have the ability to be constrained by user ownership.

User-owned constraints apply when a permission applies only to the owner of a prole or content. Without a user-
owned constraint, for example, any user with the Edit Comment permission could edit any other user’s comments. You
want to let users edit their own comments, but it’s unlikely you want them editing the comments of other users. For
that reason, the Edit Comment permission is constrained by user ownership by default. However, you may want to let
moderators edit comments, so you would clear the Constrain by User Owned check box in a moderator permission set.

Product and Category Constraints  
Individual permissions and permission sets apply everywhere on the community unless they are constrained. Some
permissions have the ability to be constrained by product/category.

You can also constrain permissions by either product or category. Whichever constraint you select—product or category
—applies for all permissions across your site. In other words, you cannot constrain some permission sets by product and
others by category. By default, products are used, but you can change the constraint to categories.

Least Restrictive Path Permissioning  
A role set with multiple permission sets will use the least restrictive permission set.

When multiple permission sets are used in a role set and a permission in one set is unconstrained while the same
permission in another permission set used in that role set is constrained, the user with that role set will have the
unconstrained permission. Assume, for example, a role set that contains two roles. Each of the roles has very similar
permission sets, except that one permission set lets the user edit only the user-owned questions and comments, while
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the other set does not have the user ownership constraint. Users who are assigned to that role set will be able to edit all
questions and comments, regardless of who the owner is. The least restrictive permission path takes precedence.

The least restrictive path also applies to permission set lters. Permissioning can get complicated with the combination
of permission sets, permission set lters, and user ownership constraints. Every access control report contains a link to
let you view the complete access control path from individual permissions to the role set. Clicking Access Control Paths
in the Access Control editor’s ribbon lets you view every path.

Overview of Community Roles  
Roles combine the permissions granted in the permission sets with the product or category lters of the permission set
lters.

Every user has at least one role, and several default roles are included in the reference implementation. When you click
Roles in access control, the roles report displays.

You can drill down on these values in the report.

• The number of permission sets assigned to the role

• The number of permission set lters assigned to the role

• The number of role sets that include the role

You can also click the View link to see the access control path from individual permissions to role sets.

Seven default roles are included in the reference implementation.

• Everyone—This role uses the Default Community Viewer permission set that gives users read-only access to
community content.

• Default Contact—This role uses these permission sets.

◦ Default Community User—Lets users create and edit their community prole.

◦ Default Community Author—Lets users create, ag, and rate questions and comments as well as manage
their own content (edit, delete, and select best answer).

• Default Account—Same as Default Contact.

• Default Community User—Same as Default Contact and Default Account.

• Community User Moderator—This role uses the Default Community Moderator Users permission set that lets
moderators edit community user proles and view contact details.

• Community User Administrator—This roles uses the Default Community Admin Users permission set that lets
moderators create and delete community users.

• Community Content Moderator—This role uses these permission sets.

◦ Default Community Moderator—Lets moderators choose a best answers, lock questions, move
comments, and edit and delete questions, comments, ags, and ratings.

◦ Default Community Author—Lets users create, ag, and rate questions and comments as well as manage
their own content (edit, delete, and select best answer).

Edit a Role  
You can edit roles to change the associations with permission sets and permission set lters.

1. Click Edit.
2. Click Roles.
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3. Right-click the role you want to edit and select  Open > Role .
4. To add a permission set, click Add and select the permission set from the drop-down menu in the Permission

Set column.
5. To change a permission set, click the associated Permission Set drop-down menu and select a dierent

permission set for the role.
6. To dene a permission set lter, follow these steps:

a. Clear the Unconstrained check box.
b. Click Permission Set Filter.
c. Expand the Community or Custom folder.
d. Select the permission set lter.

7. Click Save.

Create a Role  
In addition to editing default and custom roles, you can also create new roles.

1. Click Edit.
2. Click Roles.
3. Click New and select Role.
4. Enter the role name in the Name eld using only leers, numbers, and underscores.
5. Enter a descriptive name for the role in the Labels eld.

You can use spaces and special characters, but each custom role must have a unique label.
6. To describe the role, enter information in the Descriptions eld.
7. To add permission sets and permission set lters, complete these steps for each set:

a. Click Add and select a permission set from the drop-down menu in the Permission Set column.
b. To dene a permission set lter, follow these steps:

i. Clear the Unconstrained check box.
ii. Click Permission Set Filter.

iii. Expand the Community or Custom folder.
iv. Select the permission set lter.

8. Click Save.

Delete a Role  
You can delete any role in the Custom folder or its subfolders, but you cannot delete the default Community roles. Nor
can you delete a role that is used in a role set.

1. Click Edit.
2. Click Roles.
3. Right-click the role you want to delete and select  Delete > Role .
4. Click Yes.

Create a Role Set  
Although you cannot edit or delete the default role sets, you can create custom role sets to address your specic
business needs.

1. Double-click Access Control.
2. Click Role Sets.
3. Click Edit.
4. Click New and select Role Set.
5. Enter the role set name in the Name eld using only leers, numbers, and underscores.
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6. Enter a descriptive name for the role set in the Labels eld. You can use spaces and special characters, but each
custom role set must have a unique label.

7. To describe the role set, enter information in the Descriptions eld.
8. Click the arrows next to the Community and Custom check boxes on the Roles tab to expand the list of roles.
9. Select the roles you want the new role set to include.

10. Click Save.

Copy a Role Set  
You can copy a default or custom role set to create a new role set.

1. Click Edit.
2. Click Role Sets.
3. Right-click the role set you want and select  Copy > Role Set .
4. To change the default name of the copied role set, enter the new name in the Name eld.
5. Enter a new name for the role set in the Labels eld.
6. Click Save.

Edit a Role Set  
You can edit existing custom role sets.

1. Click Edit.
2. Click Role Sets.
3. Right-click the custom role set you want and select  Open > Role Set .
4. To change the name of the role set, enter the new name in the Name eld.
5. To change the label of the role set, enter the new label in the Labels eld.
6. To select additional roles to include in the role set, select the check box for the role you want to add.
7. To remove roles from the role set, clear the check box for the role you want to remove.
8. Click Save.

Add Role Set Callout to Community Questions  
You can congure role set callouts on community questions and comments to highlight community activity. Aribute
seings must include the role set ID, a pipe separator, and the text of the callout.

1. Open /views/pages/social/questions/detail.php.
2. Locate <rn:widget path="discussion/QuestionDetail" sub:prodcat:verify_permissions=”Create” />.
3. Edit the widget code to add the author_roleset_callout aribute and modify the label. <rn:widget

path="discussion/QuestionDetail" sub:prodcat:verify_permissions=”Create” author_roleset_callout="5|

Posted by Advanced Moderator" />

4. Save the le.

Delete a Role Set  
You can delete any role set in the Custom folder or its subfolders, but you cannot delete the default role sets.

1. Click Edit.
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2. Click Role Sets.
3. Right-click the role set you want to delete and select  Delete > Role Set .
4. Click Yes.

View Users on the Access Control Editor  
You can view a list of all active users on the Access Control editor, or you can search for users by role sets. When Users
are selected on the ribbon, the Edit buon is disabled. When the Edit buon is selected, the Users buon is disabled.

1. Double-click Access Control.
2. Click Users.
3. To display only the users who have specic role sets, expand the Community and Custom lists and select the

role sets.
4. To display all users, select (Select All) in the Role Sets menu.
5. To view a user’s permissions, click view in the Eective Permissions column.
6. To view a user’s access control paths, click the View link.

View Pending Access Control Changes  
The changes you’ve been making to access control elements are still pending until you deploy them, which pushes
them to your production site. Review your changes before deploying them.

1. Double-click Access Control.
2. Click View Pending.
3. Click OK.

Roll Back Pending Access Control Changes  
Rolling back is the process of deleting the pending changes. Rolling back does not revert your production site to the
previously deployed version.

1. Double-click Access Control.
2. Click Rollback.
3. Click Yes.
4. Click OK.

Deploy Access Control Changes  
Before you deploy changes, be certain that you want to implement the access control changes. After you deploy, you
cannot revert to the previously deployed version. The Rollback operation merely deletes the pending changes.

1. Double-click Access Control.
2. Click Deploy.
3. Click Yes.
4. Click OK.
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Modify Social Filters to Use Categories  
When seing up permissions for your community, you can dene lters that are designed to work with either products
or categories. The default selection is product.

Review the widget documentation to ensure you’re modifying the appropriate aributes.
1. Open /views/pages/social/ask.php.
2. Locate any lines of code referencing uicontrol.

<rn:widget path="input/ProductCategoryInput" name="SocialQuestion.Product" verify_permissions="Create" /
>

3. Modify the widget code.
<rn:widget path="input/ProductCategoryInput" name="SocialQuestion.Category"
 verify_permissions="Create" />

4. Repeat the above steps on these pages.
a. account/notif/list.php
b. social/questions/detail.php
c. products/lists.php
d. moderate/comment.php
e. moderate/question.php

Modify the Community Question Rating Type to Stars  
The available rating types include upvote, star, and updown.

1. Open /views/pages/social/questions/detail.php.
2. Locate <rn:widget path="discussion/QuestionDetail" sub:prodcat:verify_permissions=”Create” />.
3. Edit the widget code to add the rating_type aribute and modify the label.

<rn:widget path="discussion/QuestionDetail" sub:prodcat:verify_permissions=”Create”
 sub:rating:rating_type=”star”label_be_first_to_vote=”Rate this question” /> 

4. Save the le.

Modify the Community Comment Rating Count to Graphical  
The default rating count on community questions and comments is numerical. The available rating count types include
numerical and graphical.

1. Open /views/pages/social/questions/detail.php.
2. Locate <rn:widget path="discussion/QuestionComments"/>.
3. Edit the widget code to add the rating_count_format aribute and modify the label.

<rn:widget path="discussion/QuestionComments" sub:rating:rating_type="star" label_be_first_to_vote="Rate
 this question" sub:commentRating:rating_count_format="graphical"/> 

4. Save the le.
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Remove the Best Answer Voting Option  
User, moderators, and administrators can select which answer best addresses the posted question. This option is
enabled by default.

1. Open /views/pages/social/questions/detail.php.
2. Locate the following line of code.

<rn:widget path="discussion/QuestionComments"/>

3. Edit the widget code to add the best_answer_types aribute.
<rn:widget path="discussion/QuestionComments" best_answer_types="none"/> 

4. Save the le.

Overview of the Customer Portal Avatar Library  
You can add images to your avatar library for your users to choose from.

Community users can update their public prole to use an avatar image. By default, the user’s avatar is a square with the
initial leer of their user name.

As a community administrator, you can customize the avatar library. You may want to add branded images to
personalize your customer’s experience or promote a product release.

Source les for the avatar library are stored in two folders located in assets/images/avatar_library/.

• display/everyone/—images that display next to the user’s name in posts and on the Prole page

• gallery/everyone/—images (limited to 160 x 160 pixels) that appear on the Gallery page

You can set these aributes for the avatar library.

• le size: default=150k; max=250k

• le type: default=png; other options=gif, jpg, jpeg

• total avatars: default=100; max=500

Create Role Set Avatar Library for Moderators  
You can customize the avatar choices available by groups, based on role sets.

1. Identify the Role Set ID.
a. Click Access Control.
b. Click Role Sets.
c. Identify the Role Set ID for Community Moderator Role Set.

2. Create a folder for the moderator role set avatar library.
a. Open the le location: assets/images/avatar_library/.
b. Create a new folder named moderators in the display and gallery folders.
c. Upload images to both moderators folders.
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3. Open views/pages/account/prole_picture.php.
4. Locate this code.

<div class="rn_PageContent rn_Profile rn_Container">
<rn:widget path="input/SocialUserAvatar" avatar_library_folder_roleset_map="1|everyone|All Users" />
</div>

5. After All Users, enter code for the additional folder views in this format: roleset ID|folder|label.
<rn:widget path="input/SocialUserAvatar" avatar_library_folder_roleset_map="1|everyone|All Users;5|
moderators|Moderators" />

Support Use of Facebook Prole Picture  
If you’ve enabled Facebook login support, you can allow Facebook users to use their Facebook prole picture in
Customer Portal.

1. Make sure the following widgets are activated: SocialUserAvatar (v.1.2) and OpenLogin (v.1.5).
2. Open views/pages/account/prole_picture.php.
3. Add Facebook to the avatar_selection_options aribute.

Your code should resemble the following.
<rn:widget path="input/SocialUserAvatar"
 avatar_selection_options="default,avatar_library,gravatar,facebook" />

Moderating Community Self Service  

Moderators and Community Self Service  
Community Self Service tools help moderators identify content that needs their aention and lets them take
appropriate action.

Your Community Self Service community will no doubt be a busy place, and you’ll want to be sure it remains useful, well
organized, and respectful for your community users. When you assign moderators—either from your organization’s
sta or from within your user community or both—you give them permission to interact with user-generated content
and with community users.

A moderator’s role primarily includes managing content and users. Your moderators can edit, remove, and delete
discussion content. For example, they may mark a comment as the best answer to the question, suspend a comment
so it is visible only to moderators, lock a question, change the product associated with the question, or pin a question to
the top of the list of discussions. They can also suspend, delete, and restore users as needed.

You can congure dierent types of moderators with dierent permissions and roles. For example, you might want to
allow trusted members of your community to moderate content but restrict the moderation of users to sta members.
The Access Control component contains several default permission sets and roles that should meet your needs.
And, if you need more exibility, you can create your own moderator role set using any combination of the available
permissions and lters.
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Moderator Accounts  
A moderator has the ability to edit, move, suspend, delete, and restore community users and their content.

A moderator’s ability to moderate your community depends ultimately on how you dene the moderator’s access
controls. You can create a variety of moderator role sets with whatever combination of permissions you choose.

Users with the Community Moderator role set have all the permissions assigned to general community users—creating
and editing a user account, adding, editing, and deleting their own discussion content, and viewing, agging, and rating
all community content. Moderators with this role set can also:

• Work on the moderator interface.

• Create, edit, and delete questions, comments, ags, and ratings of other users.

• Change the product associated with the question.

• Edit community users’ display name, avatar, and status and view users’ contact data.

• Choose the best answer for a question.

• Edit status and make rating adjustments for other users’ questions and comments.

• Lock discussions.

Users with the Community User Admin role set can view the moderator interface and create and delete community
users.

Some of the questions you might consider as you go about dening moderator roles for your community include:

• Do you want moderators to be able to suspend, restore, and delete users?

• Do you want to let them edit or delete another user’s content?

• Will you restrict them by product or category?

• Do you want moderators who can suspend content to be able to approve it, or do you want a dierent group of
moderators to approve it?

The Moderation Overview Page  
The moderation dashboards provides moderators an overview of all community activity and lets them perform multiple
actions.

For the best experience, moderation dashboard users should use Chrome, Firefox, or Internet Explorer 10 and above. If
your moderate role set does not include permissions for moderating users, you will not see the Moderate Users tab or
information about users on the Moderation Overview page.

The logged-in moderator selects Moderation from the drop-down menu that appears when the display name is clicked.
This link and menu is generated by the AccountDropdown widget on the standard template.

The Moderation Overview page opens to provide a snapshot of question, comment, and user activity for the past 90
days. The table, generated by the ModerationSummaryTable widget, breaks the totals down into suspended, active,
and archived statuses. Moderators can drill into any of the values to see a list of selected items having the particular
status. Drilling down on these values opens the same moderation dashboards that are accessed through the Moderate
Comments, Moderate Questions, and Moderate Users tabs in the header.
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Announcements are displayed at the top of the page and are rendered with the AnnouncementText widget.

The boom of the Moderation Overview page contains a graph of new questions and comments for each of the last
seven days and a similar graph of new users for the last seven days. Both graphs are rendered by the ActivityCharts
widget.

Content Moderation  
Moderators can take a variety of actions on questions and comments in your community.

Moderators can take these actions on discussion content submied by community users, if you have given them
sucient permissions.

• Editing content—Changing the subject and body of a question and the body of a comment (comments do not
have subjects) and changing the product associated with the question.

• Suspending content—Making content not visible to non-moderator community users but visible to community
moderators.

• Approving/restoring content—Making content visible to the community again after it has been suspended by a
moderator (approving) or set to pending by the system (restoring).

• Deleting content—Removing content from a discussion so the content remains in the database but has its
status set to Deleted (soft delete) or deleting content from the database (hard delete).

• Locking discussions—Preventing additional comments from being made and ags or ratings from being set.

• Moving questions—Associating a question with a dierent product (or category) by editing the question and
selecting a new product.

• Reseing ags—Seing the ag count back to zero.

User Moderation  
Moderators have access to your customer’s community proles.

Moderators can take these actions on community users, if you have given them sucient permissions. These actions
aect only the customer’s community prole, not their contact record in your database.

• Suspending users—Preventing a user from logging in, creating content, and receiving subscription emails. This
user’s active content remains visible. You would expect this user to be restored.

• Archiving users—Same as suspending, except you would not expect to restore these users, for example, sta
members who have left your organization.

• Restoring users—Changing the user’s status back to active.

• Deleting users—Removing a user without the possibility of restoring the account.

• Viewing user information—Viewing information from the user’s contact record.

• Changing avatar and display name—Replacing the user’s picture and changing the display name used by the
account.
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The Comment Moderation Dashboard  
The ModerationAction widget lets users with the role set perform a combination of actions from the Comment
Moderation dashboard.

None of the moderation action buons are active until at least one comment is selected. If you do not have permission
to perform an action, the associated moderation action buon is disabled. No comments from deleted questions appear
in the Comment Moderation dashboard.

• Suspend—When you suspend a comment by seing its status to Suspended, only users with permission to
view the moderator user interface can view the comment.

• Approve/restore—You can approve a suspended comment to change its status from Suspended to Active,
where every user can see it. When comments are approved, the ag count is automatically reset to zero.

• Delete—You can delete a comment to make it invisible to all users, including moderators.

• Reset ags—When you reset a comment’s ags, the ag count is set to zero.

• Suspend author—You can suspend the author of a comments.

• Approve/restore author—You can approve one or more suspended authors or restore pending authors.

Filter Comments  
The Comment Moderation dashboard lets you lter your results.

1. Click Select Filters.
2. To lter comments by date, select one of the options in the Updated Date column.

◦ If you want to specify a custom date range, select the last option in the list.

◦ Enter dates in the From and To elds or use the calendar to select the dates.

3. To lter comments by status, select Active or Suspended or both in the Status column.
4. To lter comments by products, click Select a Product and select a product or subproduct.
5. Click Apply to display ltered results.
6. To remove one of the lters you selected, click the X next to the lter name.
7. To sort by the number of ags each comment has, click the up or down arrow next to the red ag symbol in the

header row.
8. To sort by the date the comment was most recently updated on, click the up or down arrow next to the Updated

On column header.

Suspend Comments  
Only users with moderation permissions can see suspended comments.

1. Do one of the following:
◦ Select one or more comments you want to suspend by selecting the check box to the left of each

comment.
◦ Select all comments on the page by selecting the check box in the heading row.

2. Click Suspend.

Approve Comments  
Users with moderation permissions can administer comments.

1. Select one or more suspended comments you want to approve by selecting the check box to the left of each
comment.
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2. Click Approve/Restore.

Delete Community Comments  
Users with moderation permissions can delete comments.

1. Select one or more comments you want to delete by selecting the check box to the left of each comment.
2. Click Delete.
3. Click Yes.

Reset Community Comment Flags  
Users with moderation permissions can administer comments.

1. Select one or more agged comments you want to suspend by selecting the check box to the left of each
comment.

2. Click Reset Flags.

Suspend Community Authors  
Users with moderation permissions can administer comments.

1. Select a comment that is authored by the user you want to suspend.
2. Click Suspend Author.

Approve Community Authors  
Users with moderation permissions can administer comments.

1. Select a comment that is authored by the suspended user you want to approve.
2. Click Approve/Restore Author.

The Question Moderation Dashboard  
The ModerationAction widget lets users assigned to the role set perform a combination of actions from the Question
Moderation dashboard.

None of the moderation action buons are active until at least one question is selected. If you do not have permission to
perform an action, the associated moderation action buon is disabled.

• Suspend—When you suspend a question by seing its status to Suspended, only users with permission to view
the moderator user interface can view the question. Even if users have the question ID to access the question
through the URL, they will see a Not Available message.

• Approve/restore—You can approve a suspended question to change its status from Suspended to Active,
where every user can see it. When questions are approved, the ag count is automatically reset to zero.

• Move—You can move a question by changing the product it is associated with.

• Delete—You can delete a question to make it invisible to all users, including moderators.

• Reset ags—When you reset a question’s ags, the ag count is set to zero.

• Suspend author—You can suspend the author of a question.

• Approve/restore author—You can approve one or more suspended authors or restore pending authors.

Filter Community Questions  
The Question Moderation dashboard lets you lter your results.

1. Click Select Filters.
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2. To lter questions by date, select one of the options in the Updated Date column.

◦ If you want to specify a custom date range, select the last option in the list.

◦ Enter dates in the From and To elds or use the calendar to select the dates.

3. To lter questions by status.

◦ Select Active.

◦ Select Suspended.

◦ Select both.

4. To lter questions by products, click the Select a Product drop-down menu to select a product or subproduct.
5. Click Apply to display ltered results.
6. To remove one of the lters you selected, click the X next to the lter name.
7. To sort by the number of ags each question has, click the up or down arrow next to the red ag symbol in the

header row.
8. To sort by the date the question was most recently updated on, click the up or down arrow next to the Updated

On column header.

Suspend Community Questions  
Users with moderation permissions can suspend questions.

1. Select one or more questions you want to suspend by selecting the check box to the left of each question.
2. Click Suspend.

Approve Community Questions  
Users with moderation permissions can approve questions.

1. Select one or more suspended questions you want to approve by selecting the check box to the left of each
question.

2. Click Approve/Restore.

Move Community Questions  
Users with moderation permissions can move questions.

1. Select one or more questions you want to move by selecting the check box to the left of each question.
2. Click Move.
3. Click Product and select a product.
4. Click Move.

Delete Community Questions  
Users with moderation permissions can delete questions.

1. Select one or more questions you want to delete by selecting the check box to the left of each question.
2. Click Delete.
3. Click Yes.

Reset Community Question Flags  
Users with moderation permissions can administer questions.

1. Select one or more agged questions you want to suspend by selecting the check box to the left of each
question.

2. Click Reset Flags.
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Suspend Community Authors  
Users with moderation permissions can administer questions.

1. Select a question that is authored by the user you want to suspend.
2. Click Suspend Author.

Approve Community Authors  
Users with moderation permissions can administer questions.

1. Select a question that is authored by the suspended user you want to approve.
2. Click Approve/Restore Author.

The User Moderation Dashboard  
The ModerationAction widget lets users perform a combination of actions from the User Moderation dashboard.

None of the moderation action buons are active until at least one user is selected. If you do not have permission to
perform an action, the associated moderation action buon is disabled.

• Suspend—When you suspend users, they can no longer log in, create content, or receive subscription emails.
Their previously created content is, however, visible to other community users.

• Approve/restore—You can approve suspended users to change their status from Suspended to Active, which
gives them the normal community permissions of logging in, creating and rating content, and receiving
subscription emails.

• Archive—You can archive users who are no longer active in your community, for example, employees who have
left your organization. Content from archived users remains visible on your community site.

• Delete—You can delete users, preventing them from logging in and hiding their previously created content
from all users, including moderators. You cannot restore a deleted user.

Filter Community Users  
You can sort the results on the User Moderation dashboard.

1. Click Select Filters on the User Moderation dashboard.
2. Select any combination of user status: Active, Suspended, or Archive.
3. Click Apply.
4. To remove one of the lters you selected, click the X next to the lter name.
5. To sort by the number of total or suspended question or comments a user has submied, click the up or down

arrow next to the appropriate symbol in the header row.
6. To sort by the number of agged questions or comments a user has, click the up or down arrow next to the

appropriate symbol in the header row.
7. To sort by the date when the user’s contact record was created, click the up or down arrow next to the Created

On column header.

Suspend Community Users  
Users with moderation permissions can suspend users.

1. Select one or more users you want to suspend by selecting the check box to the left of each name.
2. Click Suspend.

1281



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

Archive Community Users  
Users with moderation permissions can archive users.

1. Select one or more users you want to archive by selecting the check box to the left of each name.
2. Click Archive.

Approve Suspended or Archived Users  
Users with moderation permissions can administer users.

1. Select one or more suspended and/or archived users you want to approve by selecting the check box to the left
of each name.

2. Click Approve/Restore.

Delete Community Users  
Users with moderation permissions can delete users.

1. Select one or more users you want to delete by selecting the check box to the left of each name.
2. Click Delete.
3. Click Yes.

Overview of Moderating Inline Discussions  
Moderaters can administer discussions and users from the social Question Details page and the User Prole page.

Depending on the permissions assigned to you in your role sets, you can perform some or all of these actions.

• Edit—Edit the subject and body of questions, change a question’s associated product, and delete a question as
well as edit and delete comments.

• Suspend—Change the status of a question or comment so that it cannot be seen by regular community users,
only moderators.

• Approve/restore—Change the status of a question or comment from Suspended to Active so every user can
see it.

• Lock—Close a question so that no more comments, ags, and ratings can be made.

• Unlock—Open a locked question for comments, ags, and ratings.

• Best answer—Mark a comment so it appears with a “Selected Best by Moderator” tag.

• Suspend author—Suspend the author of a question or comment.

• Approve/restore author—Approve the suspended author of a question or comment.

Edit a Community Question Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Edit.
2. To edit the subject, enter new text or edit existing text in the Subject eld.
3. To edit the question, enter new text or edit existing text in the Question Body eld.
4. To change the product associated with the question, click Product and select a dierent product.
5. To delete the question, click Delete This Question.
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6. Click Save.

Suspend a Community Question Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Moderate.
2. Select Suspend Question.

Approve a Suspended Community Question Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Moderate at the top right of the question.
2. Select Approve/Restore Question.

Lock a Community Question Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Moderate.
2. Select Lock Question.

Unlock a Community Question Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click the Moderate drop-down menu at the top right of the question.
2. Select Unlock Question.

Edit a Community Comment Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Edit.
2. To edit the comment, enter new text or edit existing text in the Edit This Comment eld.
3. To delete the comment, click Delete.
4. Click Save.

Suspend a Community Comment Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Moderate.
2. Select Suspend Comment.

Approve a Suspended Community Comment Inline  
Users with moderation permissions can administer your community while interacting with it.

1. Click Moderate.
2. Select Approve/Restore Comment.

Inline User Moderation on the User Prole Page  
When regular community users access another user’s prole page, they can search the user’s contributions.

From the user’s prole page, moderators can suspend, archive, and delete the user, view the user’s contact information,
and change the user’s avatar and display name. Moderators can see a user’s rst and last names and email address,
although this information is not visible to non-moderator users.
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You can access a user’s prole page by clicking the user name in any of the dashboards or by clicking the user name
(under the avatar) from a question or comment on the Social Questions page.

Customer Portal Administration  

The Customer Portal Administration Site  
The Customer Portal Administration site lets you set the environment, view logs, and dene page set mappings.

You can also view reference information about widgets, business objects, and widget and page tags.

Open the Customer Portal Administration Site  
You access the Customer Portal Administration site to complete administrative tasks.

You must have the CP Promote and CP Stage permissions enabled in your prole. Your user name must not contain
multi-byte characters.

1. You can also access the Customer Portal Administration site through the Oracle Service Cloud product or
through a web browser.

◦ In a web browser, type hps://<your_site>/ci/admin.

◦ Double-click Customer Portal in  Conguration > Site Conguration  and select the interface in the
Interfaces tree. Then click Administration Interface.

◦ Click  File  and select Links and then click  Customer Portal > Site Administration .
2. Enter your user name and password.
3. Click OK.

Production Versus Development Environments  
The same URL is used to point to pages on both the production and development areas.

It is important that you evaluate your changes on your development pages. You can set your pages to development
mode on the Customer Portal Administration site dashboard.

When you work on your development pages, your production site remains untouched until you rst stage the
development pages and then promote them to production. However, changes you make on the development area have
the potential to aect your production data because the development site is connected to the production database. If
this is a concern, you can request a cloned site by submiing an incident on our support site.

Even though the changes you make to les in the development folder aect only the development pages, it’s possible
to unintentionally make changes that also aect your production site. These include:

• Editing les (except themes) in the assets folder—The les in the assets folder (CSS les and images, as well
as other les used on your customer portal) are shared by the development and production sites. If you edit a
le used on your production pages, your edits may be visible to customers even before you stage and promote.
You can reduce this risk by creating separate assets/development and assets/production folders. When
making changes to pages and widgets, point to the assets in the development subfolder. When you are ready
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to stage and promote, you can copy the les to the production subfolder and change the references in your
pages and widgets to that folder.

Themes, however, are handled dierently and are used only by the development les. When you stage the
development pages, the theme les are copied to a time-stamped folder in the staging directory and called by
the staged pages from that folder. This lets you keep the themes you develop in an isolated sandbox until you
promote the staged pages into production, when these les are copied into the production folder.

• Editing message bases, conguration seings, custom reports, and other conguration items—You risk
changing the look or functionality of your production customer portal if you edit message bases, conguration
seings, custom reports, or other conguration items (such as products, categories, and custom elds) used by
your production pages.

How You Set the Environment  
The Set Environment page of the administration site lets you view dierent areas of your customer portal.

When you select the Development site mode option, you can view the pages on your development site before you’ve
staged and promoted those les into production. Besides Development, the other site mode menu options include:

• Production—Displays what your customers see.

• Staging—Displays the development pages after you’ve staged them, but before you have promoted them to
production.

• Reference Implementation—Displays the Customer Portal pages before you have customized them.

By default, the site mode is set to Production.

After you’ve selected the site mode you want to view, you can select the page set you want to display. The page set
drop-down menu for selecting the standard, mobile, or basic pages is active only when the check box below the menu
is cleared. By default, the check box is selected, which means that the page set is determined by the browser or user
agent accessing the pages. As a result, the standard pages are displayed when customers access the customer portal
from a desktop browser, the mobile pages are displayed when they access from a mobile device, and the basic pages
are displayed when customers have a device with limited JavaScript capability. When this check box is selected, the user
agent of your browser is shown on the page.

The default options on the menu include Standard, Mobile, and Basic. The mobile and basic pages must be enabled
before they appear in the menu. Any other page sets you have added on the Page Set Mapping page also appear in
the menu. Selecting Standard displays your standard (non-mobile and non-basic) pages. Selecting Mobile displays the
pages associated with your mobile implementation, so you can view your mobile pages on your workstation without a
mobile device. Similarly, selecting Basic displays the basic page set on your workstation.

The current selections are identied at the top of the Set Environment page and on the View Site drop-down menu.

Set the Site Mode  
You set the site mode to view dierent site les.

1. In a web browser, enter https://<your_site>/ci/admin.

◦ To set the development area mode, click View Development Area.

◦ To set the staging area mode, click View Staging Area.
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◦ To set the production area mode, click View Production Area.

◦ To set the reference implementation site mode, click View Site.

Related Topics
• Work in Developer Mode (video)

Set the Page Set  
You can set the page set for viewing your site.

1. Enter https://<your_site>/ci/admin.
2. Click Set Environment.
3. Make a page set selection.

◦ To display the appropriate page set based on the user agent that is accessing the customer portal, select
the check box (below the page set drop-down menu) that says “Allow my current browser/user agent to
be the deciding factor.”

◦ To display the standard (non-mobile) page set, clear the check box and select Standard on the page set
drop-down menu.

◦ To display the mobile pages, clear the check box and select Mobile.

◦ To display the basic page set, clear the check box and select Basic.

◦ To display a custom page set, clear the check box and select the page set name in the menu.

4. Click Set Viewing Mode and View Site.

Overview of the Development Header  
The development header provides information about errors, warnings, widget information, and additional links and
resources.

When you view the development area, you’ll see a Customer Portal Development Area header, including version
number, on the page.

To close the header, click X. (If you want to display the header again, refresh the page.) To expand the header and
display these options, click the header. You can then expand and collapse each heading by clicking the associated plus
(+) sign.

• Errors and warnings: When you click the + sign on the Errors and Warnings heading, it displays the number
of errors, warnings, and notications for the page. If errors or warnings occur on the page, the development
header displays an exclamation point that you can click to view the error or warning.

• Page widget information: When you expand the Page Widget Information section, two links are displayed:
one to show the list of widgets on the page and one to show URL parameters used by the page. Clicking the
rst link displays a list of all widgets on the page, their version, and whether they are up-to-date. If the widget
is compatible with the framework, a check mark appears in the Up to Date column. If it is out-of-date, an X
appears in the column.Clicking the second link displays each of the URL parameters used by the page, its value,
whether the parameter is required, and a description.

• Links and resources: There are links available on the Links and Resources section of the development header to
the Production Area, the Customer Portal administration page, the reference implementation, and others.
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Page Set Maps  
You can automatically direct customers to the correct interface based on page set mappings.

When you let the browser or user agent determine which page set is displayed, customers can be automatically
directed to the correct interface based on the browser they are using. If they’re using a desktop or laptop computer, for
example, you can direct them to your standard customer portal pages. But if they’re using a mobile device, you probably
want them to be directed to your mobile customer portal interface. And customers using devices that don’t support
JavaScript can still view your site with the basic page set. Page set mapping also lets you dene unique page sets for
various user agents.

Page set mappings aect only the development area until you stage and promote the customer portal. To make page
set mappings active on your production site, you must stage and promote after saving your changes. The default
mappings cannot be edited.

User Agent Mapping  
With the appropriate selection, the customer portal can identify the customers’ user agents and direct them to the
appropriate page set.

When you click the Set Environment shortcut on the dashboard, the Set Environment page of the Customer Portal
Administration site displays your user agent if the page set check box (Allow my current browser/user agent…) is
selected. The default page sets are your standard customer portal pages and the mobile page set.

Oracle Service Cloud includes two default mappings to the mobile page set and one for the basic page set. These
mappings are initially disabled, so you must enable at least one of the mobile page sets and the basic page set and
then stage and promote your customer portal site before they are available to your customers. Until you do so,
your customers will see your standard customer portal pages even when they are using a mobile or basic device.
Additionally, these page sets will not appear in the page set menu on the Set Environment page.

Enable Default Page Set Mappings  
You must enable the default page set mappings to let customers see those page sets.

1. In a web browser, open https://<your_site>/ci/admin.
2. Click Page Set Mappings and enable the appropriate page sets.

◦ To enable one of the mobile page sets, click Enable for one or more of the mobile devices (iPhone and
Android).

◦ To enable the basic page set, click Enable for the basic page set.

Related Topics
• Add Page Set Mappings
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Add Page Set Mappings  
You can create unique pages sets and map them to specic user agents to provide customer portal pages that display
dierently on dierent browsers.

1. In a web browser, open https://<your_site>/ci/admin.
2. Click Page Set Mappings.
3. Click Add Mapping.
4. Enter a valid Perl-compatible regular expression in the User Agent Regular Expression eld or leave the eld

blank.
5. Enter a description that can be used for reporting purposes in the required Description eld.
6. Enter a path in the required Page Set eld.

Note:  If you create a mapping to a page set folder that does not exist, you cannot save the mapping.
If the folder is deleted after the mapping is created, customers who try to access it through a browser
will see an error message about too many redirects. (The exact message is browser dependent.) The
recursive loop error occurs because it fails to nd the nonexistent folder results in a redirect to an error
page in the same folder, which also cannot be found.

7. Click Save.

How You Delete and Disable Mappings  
You cannot delete the default mappings for the iPhone, Android, and basic page sets, but you can delete any page set
mapping you have added if you have not yet saved it.

To delete a mapping, click Delete in the row containing the mapping.

If you have staged and promoted the mappings you have added, you can no longer delete them, even by rolling back
the site, but you can disable them by clicking Disable. You can also disable the default mappings. You must stage and
promote the customer portal after you disable a mapping so the change will take eect on your production site.

Overview of the Framework Tab  
The Framework tab lets you see information about the available frameworks.

When you type hps://<your_site>/ci/admin/docs/framework into your browser or click the Framework tab from
any page of the Customer Portal Administration site, the Framework page opens.

These options are available on the page and also from the drop-down menu that displays when you hover over the
Framework tab.

• Framework Versions—Click this link to see the frameworks that are available and to set the framework version
you want to use for your development pages.

• Page Tags—Click this link for a list of tags that control specic sections of the page or that hide or display
content conditionally.

• Page Meta Tags—Click this link to see the aributes that can be dened for each page. These include, among
others, whether login or an SLA is required to view the page, the template used by the page, and the page title.
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• Business Objects—Click this link to display eld information for adding answer, incident, and contact elds
to input and output widgets and the Field page tag. The page displays the format to use for display and input
widgets as well as the data type for each eld.

• Old Framework Migration—If you have migrated to Framework Version 3.3 from Framework Version 2, you can
revert your development pages to the older framework. Your staging and production environments are not
aected, and you can change back to Framework Version 3.3 later if you change your mind.

Note:  The Old Framework Migration option does not appear if your Customer Portal installation is new with
Framework Version 3.3.

Framework Versions  
A list of available framework versions is available on the Framework tab.

When you click the Framework tab and select Framework Versions, you’ll see a list of the available Customer Portal
frameworks in the left column.

For instance, the May 2015 release used Framework Version 3.2.6. If you had been using any nano version (3.2.1
through to 3.2.5) of Framework 3.2 and then upgraded to the May 2015 release, your customer portal would have been
automatically migrated to 3.2.6 because nano increments are fully backward compatible.

The August 2015 release, however, was a minor release, which required migration to Framework Version 3.3 and
probably required editing custom code. As a result, the November 2015 nano upgrade is 3.3.2. If your site uses an earlier
framework (3.0, 3.1, or 3.2), you can choose to keep using it upon upgrade to November 2015 until you decide to migrate
to the 3.3 version to take advantage of increased functionality, including Community Self Service.

The list of frameworks in the left column shows the version being used by each of the three environments.

When you click a framework, the changes that are included in that version are dened.

You can mouse over the bullet for each change to learn which type of change it is.

• Likely to impact custom code (major version change)

• May impact custom code (minor version change)

• No impact to custom code (nano version change)

Additionally, the changes are divided into these areas.

• New features

• Removal of functionality

• API changes

• Bug xes

Additional information about the change and what you might need to do to incorporate the change is available by
clicking the link at the end of each line.

Overview of Reverting to an Earlier Framework  
You can choose to revert to an earlier framework version.
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You can select the version and clicking Start Using This Version, to begin using an earlier framework version.

Whenever you revert to an earlier framework, you will likely encounter errors resulting from newer widgets being
incompatible with the older framework, which will require additional work on your part to correct the pages that use the
new widgets. We do not recommend you revert your customer portal, but we recognize there are times when you may
need to do so.

When you click the buon, you’ll see a list of widgets that are not compatible with the framework version you select.

You have the option of updating both the framework and widgets or only the framework. If you click Update the
Framework, the success message instructs you to manually update the outdated widgets to a version that is compatible
with the framework. If you do not, errors will appear on your development pages, and you will experience errors when
you try to stage and promote your site.

If you select Update Widgets and Framework, all of the widgets that require a version change to be compatible with the
older framework are modied. Your site may still contain compatibility errors so be sure to check your development
pages carefully before staging and promoting to prevent errors during the deploy process.

Business Objects Available in a Framework Version  
You can see the available business objects on the Framework tab.

When you are adding a eld to the aributes of a Field page tag or the FormInput or DataDisplay widgets, you might not
know its Connect PHP API eld name.

Click the Framework tab and select Business Objects to look up eld and table names so you can include them in
the widget code. The link displays elds in the Answer, Asset, Contact, Incident, ServiceCategory, ServiceProduct,
SocialQuestion, SocialQuestionComment, and SocialUser tables. The page also provides examples to use for display and
input.

If you want to see the description of an object, hover over its name. To view complete information about the object,
click it to open a window that displays data type, description, and default value for answer business objects, as well as
additional information for contact and incident objects. Click Close.

Overview of the Widgets Tab  
The widgets tab lets you browse widgets and view their information.

When you type hps://<your_site>/ci/admin/docs/widgets into your browser or click the Widgets tab from any
page of the Customer Portal Administration site, the Widgets page opens.

These options are available on the page and also from the drop-down menu that displays when you hover over the
Widgets tab.

• Browse Widgets—Click this link to display links to the lists of standard and custom widgets, organized by
folders.

• Widget Versions—When you click Widget Versions, you can select a widget to open detailed information for
that widget, including a preview image, documentation, where the widget is used, and any version changes.

• Create a New Widget—Clicking this link opens the widget builder that lets you create a new widget, either from
scratch or by extending an existing standard or custom widget.
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• Widget Info—Species the details that should be included in a widget’s info.yml le.

• Syndicated Widgets—Click this link to display and congure the syndicated widgets, ConditionalChatLink,
KnowledgeSyndication, ProactiveChat, and ProactiveSurveyLink. These widgets can access the Oracle
knowledge base even though they are placed on web pages external to the customer portal.

Widget Builder  
The Customer Portal widget builder can create a new widget by extending the functionality and aributes of an existing
widget and generating custom code les for the new widget.

The code contains placeholders that you can modify to achieve the behavior you want for the new widget.

When functional changes or bug xes are added to a standard widget, the widget undergoes a nano versioning change.
As you would expect, the standard widget on your customer portal automatically migrates to the new nano version.
Additionally, any custom widgets that have been extended from that standard widget are also modied to incorporate
the enhancement or x.

The widget builder generates custom widget code when you answer a series of questions about the widget you want
to create. By creating placeholders for additional code you’ll add to further dene the custom widget, it reduces the
amount of code you must write and minimizes the possibility of errors because it creates the widget’s basic code
structure.

Overview of the Logs Tab  
The Logs section of the Customer Portal Administration site lets you view logs for WebDAV, debugging, and
deployment.

The WebDav log shows a transaction history of all changes to les, including le name, sta account, IP address, date,
action, and interface name for each change. The debug log shows log les that are generated during development using
the logMessage ( ) function, and they contain the time, calling location, and message. The deployment log lists each
log by its le name, date and time the log le was created, the type of action, and the sta member who performed the
action. Click the log to see a history of the actions performed during the operation.

WebDAV Logs  
WebDAV logs show you changes that have been made to the customer portal les.

You can view the logs if you are logged in to the Customer Portal Administration site, by clicking the Logs tab and
selecting WebDAV Logs on the Logs Overview page or from a web browser, by entering hps://<your_site>/ci/
admin/logs/webdav.

The log displays a list of le names, the sta account that took the action, the IP address from which the action was
taken, the date and time, what action was taken, and the interface. By default, the log is sorted by date with the most
recent action listed rst, but you can sort the log by any of these columns. You can also search the log by each of the
columns, for example, by account or page name.
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Sandboxed Congurations  
The Sandboxed Congurations options let you see how the value is set for each site.

Sometimes a conguration seing can have a dierent value on your development site than on the staging and
production sites.

In Framework Version 3.3, CP_CONTACT_LOGIN_REQUIRED is the only seing that can be dierent in the dierent
areas.

When you change this kind of seing on the administration interface, the changes aect only the development and
reference implementation pages of the customer portal, not the staging and production pages. When you stage the
development pages, the changed conguration seing value is active in the staging environment. And when the staged
pages are promoted, the change aects the production pages used by your customers.

Connect Object Explorer  
The Connect Object Explorer uses a ROQL (RightNow Object Query Language) query interface to help you become
familiar with Connect more quickly.

You will learn more eciently because you can explore Connect and the data it exposes from the Customer Portal
Administration site instead of logging in to the administration interface in Oracle Service Cloud.

In addition to the ROQL query interface, the Connect Object Explorer also provides an object and eld explorer to view
Connect objects and metadata.

When you interact with the Connect Object Explorer, you gain detailed information about all Connect objects, which
improves your eciency and makes it easier to adopt Framework Version 3.3.

Use the Connect Object Explorer  
The Connect Object Explorer uses a ROQL (RightNow Object Query Language) query interface to help you become
familiar with Connect more quickly.

1. Open hps://[your_site]/ci/admin.
2. Click  Tools > Connect Object Explorer .
3. Enter a ROQL query in the New Query eld.

 select ID, Name.First, Name.Last, Emails.Address FROM Contact LIMIT 10

4. Click Execute.

◦ To sort the results on any column, click the column heading to sort in ascending order.

◦ To see additional results, click Previous or Next.

◦ To examine the metadata of a record, click its ID (or click the value in the rst column if the rst column is
not ID).

◦ To conduct another query, click + to add a new tab, and repeat steps 3 through 7.

◦ To export the data in a comma-separated values (CSV) le, click Export.
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◦ To clear the query (and any results if the query was executed), click Clear.

◦ To view the history of prior queries, click History.

◦ To display a list of all Connect primary objects, click Objects.

◦ To view metadata for an object, click it to display a table of eld names, values, and eld types.

◦ To adjust seings for the Connect Object Explorer, click Seings.

◦ To change the default number of results from 25, enter a new number in the Default Query Limit eld.

◦ To change the syntax highlighting theme used by the query editor, click Editor Theme and select a new
theme from the available options.

◦ To clear the query history, click Clear History.

◦ To view the supported query options, click Help.

Sample ROQL Queries  
These ROQL sample queries can help you understand how to formulate your queries on the Connect Object Explorer.

Standard object name mappings are used to automatically correct issues of character case and singular/plural form
inconsistency until you become more familiar with Connect naming. For example, in this list, all of the rst four queries
automatically appear as DESC Incident in the editor when they are executed. The desc, describe, and show queries are not
natively supported by ROQL and work only within the Connect Object Explorer.

The editor uses syntax highlighting of ROQL keywords and primary Connect objects, and you can change the theme by
clicking the Seings buon and making a selection on the Editor Theme drop-down menu.

• desc Incident

• describe Incident

• describe incident

• desc incidents

• show objects

• Show Objects

• Show Tables

• SHOW TABLES

• SHOW OBJECTS

• SELECT * FROM Mailbox

• SELECT ID, LookupName FROM Account LIMIT 10

• SELECT Contact FROM Contact LIMIT 10

• SELECT Incident.PrimaryContact.ParentContact FROM Incident LIMIT 10

• SELECT Contact FROM Contact C WHERE C.Name.First like 'C%' LIMIT 10

• SELECT Contact FROM Contact WHERE CreatedTime > '2011-10-17T16:27:42' LIMIT 10

• SELECT disabled, source FROM Contact WHERE Contact.Name.First like 'C%' AND

Contact.Address.City='Bozeman' LIMIT 10

• SELECT LookupName FROM Contact WHERE LookupName LIKE 'A%';
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• SELECT ID, Contact.Name.First, Login FROM Contact WHERE Contact.Name.First IS NOT NULL ORDER BY

Contact.Name.First ASC LIMIT 5

• SELECT ID, Contact.Name.First, Login FROM Contact WHERE Contact.Name.First IS NOT NULL

Use the DESC or DESCRIBE statement to obtain eld and relationship information about standard and custom objects
dened in the Connect Common Object Model (CCOM). You must specify the object’s name in the query, for example,
DESC Account.

The SHOW OBJECTS statement lists both standard and custom objects dened in CCOM. The SHOW TABLES statement
is an alias for SHOW OBJECTS.

The SELECT statement retrieves either rows or objects from one or more standard or custom objects dened in CCOM.
The explorer automatically detects the query type and returns either CSV data or an object with elds you can explore.

Use the Code Assistant Tool  
The Code Assistant simplies the migration process between framework versions and provides specic guidance for
updating your custom code.

You must enable Framework Version 3 before using the Code Assistant.

The widget migration wizard walks you through the custom code migration process, and the code suggestion feature
oers suggestions for improving or migrating custom code that includes YUI 2.

1. Open hps://[your_site]/ci/admin.
2. Click  Tools > Code Assistant .
3. To migrate to a dierent framework version than 3.3 (if, for example, you want to use Framework Version 3.0

instead), select the version you want from the development mode drop-down menus.

Note:  We recommend you use the selected options to prevent potential coding errors.

4. Click Next Step.

◦ To use the Code Assistant to help you migrate your widgets, click Continue.

◦ To update your custom code to YUI 3, see Update YUI 2 Code to YUI 3.

◦ To remove Intent Guide pages (because Intent Guide is not supported in Framework Version 3.3), see
Remove CP Code Assistant Intent Guide Pages.

Migrate Widgets to Framework Version 3  
You must edit the les generated by the Code Assistant in order to add the widget’s aributes and make any other
changes.

1. Select Widget Migration on the Code Assistant page and click Continue.

◦ To review the changes the Code Assistant will make to an individual widget, click +.

◦ To select individual widgets for conversion, select the check box next to the widgets you want to migrate.

◦ To have Code Assistant migrate every listed widget, select Select All

2. Click  Conrm Changes > OK .

◦ To return to the Code Assistant starting page (where you select your production and development mode
versions), click Start Over.
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◦ To return to the dashboard, click Home.

If a widget was successfully migrated, it will be activated automatically and you will be notied. If a widget could not be
activated because additional code changes are required, the message will notify you.

Edit the migrated widget les to include their Framework Version 2 features.

Update YUI 2 Code to YUI 3  
You can use these steps to update from YUI 2.

1. On the Code Assistant page, select YUI 2 to YUI 3 Suggestions from the options and click Continue.
2. Click + next to the le name to display the suggestions for editing the le’s code to work with the YUI 3

framework.
3. Open the le that needs to be updated and follow the instructions from the Code Assistant for editing the le.

The lines that need to be edited are noted. For each suggestion, hover over the question mark to see a
summary of the change, for example, “YAHOO.util.Event’s functionality was replaced with ‘Y.Event’.” Clicking
the question mark takes you to the YUI library for the element, where you can nd additional information.

4. To review your work, click Rescan.
5. To return to the Code Assistant starting page (where you select your production and development mode

versions), click Start Over.
6. To return to the dashboard, click Home.

Remove CP Code Assistant Intent Guide Pages  
You can use the Code Assistant page to remove pages or view backups.

1. On the Code Assistant page, select  Intent Guide Cleanup > Continue .

◦ To select an individual page for deletion, select the check box next to the page.

◦ To have Code Assistant delete both pages, select Select All.

2. Click  Conrm Changes > OK .

◦ To see where a backup of a deleted page is located, click +.

◦ To return to the Code Assistant starting page (where you select your production and development mode
versions), click Start Over.

◦ To return to the dashboard, click Home.

Accessing Customer Portal Backup Directory  
When the Code Assistant modies your customer portal les, it creates backup les with time stamps and stores them
for up to six months.

1. Open your Customer Portal Administration site.
2. Click Tools and select Code Assistant.
3. Click Code Assistant Backups.
4. Click + for a backup to open a list of all les in the backup directory.
5. Click an individual le to display the code for that le.
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Overview of the Language Tab  
The Language tab lets you select a language that persists across all administration pages for all interfaces.

By default, the language on the Customer Portal Administration site is the same as the language for the interface.
The Language tab appears on the Customer Portal Administration site when your customer portal has more than
one interface and at least two unique languages. The tab has a drop-down menu of the installed languages, which is
dynamically generated by querying the SiteInterface object. When you select a language from the menu, a cookie is set
and the language on the administration site uses the selected language regardless of the language of the interface.

Restore Pages to the Reference Implementation  
There may be times when you want to restore your development pages to the standard page set.

1. Open /cp/core/framework.
2. Copy the views subfolder and paste it to your desktop.
3. Copy the views folder from your desktop and paste it into the /cp/customer/development folder, selecting

Yes to All when you are asked to conrm the folder replacement.

◦ If you have modied other les in dierent subfolders in /cp/customer/development, copy and paste
their /cp/core equivalent to the appropriate development subfolder.

◦ If you have modied CSS or image les in the assets folder, you may want to replace them with the
equivalent les from the /cp/core/assets/default folder.

4. Verify your changes in the development view.
5. Stage and promote your site.

Staging and Promoting the Customer Portal  

How You Stage and Promote the Customer Portal  
Once you've developed your customer portal pages, you can push them into production where your customers can use
them.

One benet of the staging area is the ability to selectively stage and promote pages, widgets, versions, and page set
mappings without being required to implement all changes from the entire development site. When you stage your
customer portal, your selections are copied to a staging area and compiled and optimized for performance. The staging
environment looks exactly like your production environment will look when you promote the staged les. As a result,
you have one more chance to check your site before making it available to your customers.

When your staging environment looks the way you want, you can promote your changes. This process copies the pages
from the staging area to the production area, making them publicly visible. Your current production pages are backed
up in case you need to restore them. If you change your mind after promoting your staged pages to the production site,
you can revert to the most recent set of production pages with a click of a buon.
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Stage Customer Portal Pages  
You stage your customer portal pages to see how your changes will appear on the production site.

1. Double-click Customer Portal in  Conguration > Site Conguration .
2. Select the interface you want to stage from the Interfaces column.
3. Click Stage.

The rst window displays a list of les that have been changed in the development area since the last time les
were staged. By default, all new and edited les are selected to be copied to the staging area, and any les you
have removed from the development pages have the Remove From Staging action.

4. To prevent a le from being copied to the staging environment, click  Action > No Action .
5. To remove one or more les from the staging environment, click  Action > Remove From Staging .
6. Click Next.
7. To push all framework and widget version changes, including the addition of new widgets, select Yes.

CAUTION:  If you do not include pushing the version changes, any new widgets will not be available on
your staging site.

8. Click Next.
9. To copy a page set that you’ve enabled to the staging area, click  Actions > Copy To Staging .

10. To remove a development page set from the staging area, click  Actions > Remove From Staging .
11. Click Next.
12. To store a comment in the staging log le, enter a note in the eld.

You can enter up to 4,000 characters.
13. To re-initialize the staging environment, select the check box just above the Stage buon.

CAUTION:  If you select this check box, you will lose any le and page set selections you have made
during the staging process. Re-initializing means that all les in the staging area will be deleted and
replaced with the complete set of development les. Additionally, all page set mappings, conguration
seings, and version changes in the staging area will be deleted and replaced with their corresponding
les or seings from the development area.

14. Click Stage.

Note:  You will see a message if a deploy lock is in place. Clicking No cancels the staging operation and
Yes will override the existing lock and continue with the staging operation. Use caution when clicking
Yes because you may compromise another sta member’s le promote if you start overwriting les in
the staging area.

15. Click Stage.

Note:  If any widgets have been deleted, the message noties you that the deleted widget has been
deactivated in the staging environment. Also, if any of the widget versions are incompatible with the
framework, a staging error occurs and identies the incompatible widget.
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View the Splash Page  
The Customer Portal reference implementation includes a splash page that is displayed to let your customers know that
your site is undergoing maintenance.

1. In a web browser, enter https://<your_site>/ci/admin.
2. Click  Seings > Preview Error Pages .
3. Click /cp/customer/error/splash.html.

By default, your newly promoted production site is visible to customers immediately upon completion of the promote
process. You might want a lile more time to complete any manual tasks that may be required before making your
changes public on the production site. If so, you can manually turn on the splash page.

Note:  Your development and staging pages, WebDAV access to your customer portal les, and the Customer
Portal Administration site are unaected by this conguration seing.

Turn On the Splash Page  
You can turn the splash page on and o.

1. Locate CP_MAINTENANCE_MODE_ENABLED in RightNow User Interface/Customer Portal/General.
2. Click Value and select Yes.
3. Click Save.

Promote Customer Portal Pages  
You can promote stages Customer Portal pages and les to production.

Before you can promote the staging area, the prole assigned to you must have the CP Promote permission enabled.
You or your administrator can enable this permission if necessary.

1. Double-click Customer Portal in  Conguration > Site Conguration .
2. Select the interface you want to promote from the Interfaces column.
3. Click Promote.
4. To store a comment in the log le, enter a note in the eld.
5. Click Promote.
6. Click Promote.

Related Topics
• Move Customizations to Production (video)

Roll Back the Most Recent Promote Process  
You can use the Rollback feature to revert to the prior production pages.

1298

https://apexapps.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:13251


Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

Your prole must contain the CP Promote permission.
1. Double-click Customer Portal in  Conguration > Site Conguration .
2. Select the interface you want to roll back from the Interfaces column.
3. Click Rollback.
4. To store a comment in the log le, enter a note in the eld.
5. Click Rollback.
6. Click Rollback.

Deployment Logs  
The Customer Portal administration interface includes a list of deployment logs.

Deployment logs are sorted in descending order by date and include the type of deployment and the sta member who
initiated the deployment.

You can also view deployment logs from the Customer Portal Administration site. Deploy types include Stage, Promote,
and Rollback. Other deploy types include Service Packs and Upgrades.

Clicking the link for a log opens it for viewing. After you’ve viewed the log, click Back to Log Listing at the top of the log
to return to the list of logs.

Developer Overview  

Model-View-Controller Design Paern  
One of the most important aspects of the Customer Portal framework is the Model-View-Controller (MVC) design
paern, which allows the separation of logic and presentation so that each can vary independently.

The model represents your data structures. Models are PHP classes that are designed to work with information in your
Oracle Service Cloud database. Models encapsulate database API calls.

For example, the Answer model exposes a get() function that populates an Answer object, and the get() function of the
Contact model populates a Contact object. These functions are available to any controllers that load the model.

Instead of making direct SQL calls to the database, custom models can make calls to Oracle RightNow Connect PHP
API Cloud Service (Connect PHP API) and use the data objects from that API. Models can also use the Oracle RightNow
Object Query Language (ROQL) to access the database.

Standard models call the native abuse detection methods. However, in some circumstances, such as when your custom
code makes direct Connect PHP calls, or when it overrides standard controllers, your custom code must contain abuse
detection calls.

The view is the information that is presented to a customer, usually a web page, although it can be a page fragment
such as a header or a sidebar. Views are the page, template, and widget content combined with the CSS, images, and
other assets that comprise the presentation part of the architecture.

Views are not called directly, but instead must be loaded by a controller. Any YUI components and other scripts are
invoked from within the nalized view. The customer’s experience is therefore controlled from the client side by HTML
and JavaScript.
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The controller is the intermediary between the model, the view, and any other resources needed to process the HTTP
request and generate a web page. The controller is responsible for receiving the request, calling the appropriate models,
and passing data to the view. Controllers are PHP classes that are accessible through URI (Uniform Resource Identier)
requests. They call models, libraries, and helpers as required, and pass data to the view for display.

RightNow provides a set of application controllers that handle the URI requests. Examples include:

• Page—Processes the page requests and loads the appropriate page or template.

• AjaxRequest—Processes all of the AJAX requests made from client-side widget logic les.

• Faach—Processes any le aachment requests.

The index.php le is called the front controller. It is distinct from the application controllers like Page.php and
AjaxRequest.php and is specic to the Oracle web hosting environment.

The front controller receives the request URI, inspects the request, and then determines what modications are
necessary for the query string.

When the request URI contains… The front controller…

/app Presets the Page controller and the render function (page/render).

/dav Presets the WebDAV controller’s index function (webdav/index).

/ci Does not preset any controller or function. Instead, the next two URI segments specify what to load
and execute. For example, when the front controller sees ci/ajaxRequest/sendForm, it loads
the ajaxRequest controller and executes the sendForm() function. URIs containing /ci are used only
for standard controllers.

/cc Calls a custom controller. The format is: cc/class_name/function_name.

Widgets have their own view and controller les and can also make calls to models.

When a user accesses a customer portal page, the view le for each widget presents the HTML for that widget, and the
user can then interact with the widget. If the user clicks a buon or link on the widget to submit the page to the server,
the submission request goes to the controller. If part of the request requires data, the controller calls a model function
to interact with the database and return the data to the controller. The controller then passes any updates back to the
view, which refreshes the widget and displays it on the web page.

A model is not always necessary, because data from the database is not required for every widget.

Client-Side Scripting Framework  
The Customer Portal takes advantage of the YUI library, an open source JavaScript and CSS library for building richly
interactive web applications using techniques such as DOM scripting, DHTML, and AJAX. Customer Portal Framework
Version 3.3 uses YUI Version 3.17.

Some YUI features used by Customer Portal include:

• Yahoo Global Object

• DOM collection

• Event utility
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• Utilities, for example, the browser history manager

• Widgets such as auto complete and buon control

The entire YUI library set is included with the Customer Portal. Although the reference implementation does not use the
entire YUI framework, you can use these additional libraries for your customer portal implementation.

The Customer Portal Framework Version 3.3 has extended the YUI libraries for integration with the server-side scripting
framework. This integration of technology makes it easy to create reusable functionality without having to handle
variables and visit information. Typically, these libraries are associated with the specic widget functionality you
are trying to create. Review the standard widgets located in /cp/core/widgets in the reference implementation for
examples of this integration.

Connect PHP API  
The Connect PHP API provides a set of classes you can use to interact with the CCOM.

Queries in a custom model can use three built-in static methods.

• The fetch() method—Returns a single object based on its ID.

• The rst() method—Returns the rst record that matches a query string.

• The nd() method—Returns an array of all matches for that string.

See the Connect PHP API Developer Guide.

This is an example of a function in a model that includes calls to the Connect PHP API.

 <?php
 namespace RightNow/Models;
 use RightNow/Utils/Url,
 ... 
 RightNow/Connect/v1_2 as Connect,
 ...
 public function get($contactID = null){
 static $contactCache = array();
 if($contactID === null){
 if(Framework::isLoggedIn()){
 $contactID = $this->CI->session-
>getProfileData('contactID');
 }
 else{
 return $this->getResponseObject(null, null, "No contact 
ID specified and no contact is logged in.");
 }
 }
 if(!Framework::isValidID($contactID)){
 return $this->getResponseObject(null, null, "Invalid 
Contact ID: $contactID");
 }
 if($cachedContact = $contactCache[$contactID]){
 return $cachedContact;
 }
 try{
 $contact = Connect/Contact::fetch($contactID);
 }
 catch(Connect/ConnectAPIErrorBase $e){
 return $this->getResponseObject(null, null, $e-
>getMessage());
 }
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 $contactCache[$contactID] = $this-
>getResponseObject($contact);
 return $contactCache[$contactID];
 }

Connect Common Object Model  
The CCOM denes a set of objects representing entities in the Oracle Service Cloud knowledge base that can be
displayed on the Customer Portal.

CCOM includes these types of objects:

• Primary object—Primary objects have a unique key and can be created, read, updated, or deleted directly. They
can contain either data elds that hold primitive date types or sub-objects. Primary objects represent entities in
the knowledge base such as answers, contacts, and incidents.

• Sub-object—Sub-objects may also contain primitive data types or other sub-objects. Sub-objects do not have
a separate existence and are manipulated through their parent primary object. An example of a sub-object is
PersonName, which is contained in the Contact primary object.

• Array object—An array object is a collection of sub-objects.

Use dot notation to identify objects in CCOM. For example, to access the rst name of a contact, use
Contact.Name.First.

For more information about CCOM, see the Connect PHP API Developer Guide.

Oracle RightNow Object Query Language  
ROQL provides an alternative to the Connect PHP API for accessing data in the knowledge base.

A ROQL query is similar to a SQL query, but there are some exceptions, including:

• FROM is followed by the singular name of a RightNow object.

• You can retrieve either a whole object or individual elds.

• Not all SQL functions are supported.

• Traditional joins and nested queries are not supported.

There are two types of ROQL query. Tabular queries are similar to SQL queries and return rows of comma-separated
values.

 function lookupByLastName($search_string) {
 initConnectAPI();
 $query ="SELECT Contact.Name.Last, Contact.Name.First FROM
 Contact WHERE Contact.Name.Last = "'".$search_string."'";
 $roql_result=RNCPHP/ROQL::query($query)->next();
 $row = $roql_result->next(); 
 $name = $row[firstname]." ".$row[lastname];
 echo $name;
 }

Object queries return complete objects rather than individual eld names.

 function lookupByLastName($search_string) {
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 initConnectAPI();
 $query ="SELECT Contact FROM Contact WHERE 
 Contact.Name.Last = "'".$search_string."'";
 $roql_result=RNCPHP/ROQL::queryObject($query)->next();
 while($contact = $roql_result->next()) {
 $rows[] = array("last" => $contact->Name->Last);
 }
 echo $rows;
 }

See the Connect PHP API Developer Guide for more information about ROQL.

Namespaces  
Use this example to learn more about namespaces, their aliases, and declarations.

This example comes from /cp/core/framework/Models/Contact.php:

<?php /* Originating Release: August 2014 */
 namespace RightNow/Models;
 use RightNow/Utils/Url,
 RightNow/Utils/Framework,
 RightNow/Utils/Config,
 RightNow/Api,
 RightNow/Connect/v1_2 as Connect,
 RightNow/Internal/Sql/Contact as Sql,
 RightNow/Utils/Connect as ConnectUtil,
 RightNow/ActionCapture,
 require_once(CORE_FILES . 'compatibility/Internal/Sql/Contact.php');
 class Contact extends PrimaryObjectBase {
 . . . 
 }

In this example, a namespace declaration (namespace RightNow/Models) shows that the contact.php le belongs in the
RightNow/Models namespace. In order to reference the class le you must use RightNow/Models/Contact. The reference
reects the folder where the example is located. The example also includes a number of namespace aliases.

Here the code uses the Custom namespace in /cp/customer/development/models/custom/Sample.php:

<?php
 namespace Custom\Models;
 class Sample extends /RightNow/Models/Base
 . . . 
 }

This example contains the namespace declaration, namespace Custom/Models, and a reference to the Base class in the /
RightNow/Models namespace.

Here is an example of how you can use namespace aliases in your custom code.
use RightNow/Connect/v1_2 as Connect;

This oers a shorthand way of referencing namespaces within a le. In this case, you can use the alias Connect, like this:
Connect/NamedIDLabel(); instead of RightNow/Connect/v1_2/NamedIDLabel(); when referencing the namespace.
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Keep in mind these requirements for PHP namespaces in your customer portal code.

• When you reference global objects, such as classes, interfaces, functions, or constants, from within a
namespaced class, you must prepend the object with a backslash as shown here throw new \Exception('Invalid
state').

• When you reference a namespace in a string, you must escape each backslash as shown here $controller="\/
RightNow\/Controllers\/$library";.

• You must place the namespace declaration at the top of the le before any other code, with the exception of a
declare statement.

Primary Namespaces  
Primary PHP namespaces relate to the Customer Portal le system.

Namespace Directory

RightNow/Controllers
 

/cp/core/framework/Controllers
 

RightNow/Hooks
 

/cp/core/framework/Hooks
 

RightNow/Libraries
 

/cp/core/framework/Libraries
 

RightNow/Libraries/Widget
 

/cp/core/framework/Libraries/Widget
 

RightNow/Models
 

/cp/core/framework/Models
 

RightNow/Utils
 

/cp/core/framework/Utils
 

RightNow/Widgets
 

/cp/core/widgets/standard
 

Custom/Models
 

/cp/customer/development/models
 

Custom/Widgets
 

/cp/customer/development/widgets/custom
 

Widget Namespaces  
Standard widgets are in the RightNow/Widgets namespace.

This is an example from the DateInput widget in /cp/core/widgets/standard/input/DateInput/controller.php:

<?php /* Originating Release: August 2014 */
 namespace RightNow/Widgets;
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 use RightNow/Utils/Config,
 RightNow/Connect/v1_2 as Connect;
 class DateInput extends /RightNow/Libraries/Widget/Input {
 . . . 
 }

Custom widget namespaces must start with Custom/Widgets, and the remaining namespace segments must reect the
name of the parent directory of the directory that contains the widget les.

This example is from the DateInput widget’s logic.js le in /cp/core/widgets/standard/input/DateInput:

 /* Originating Release: August 2014 */
 RightNow.Widgets.DateInput = RightNow.Field.extend({
 overrides: {
 constructor: function() {
 this.parent();
 . . . 
 }
 . . .
 });

In the example, the namespace for the DateInput widget is declared as RightNow.Widgets.DateInput, and it extends from
RightNow.Field.

Custom widget namespaces must use Custom.Widgets as the rst two namespace segments, and the remaining segment
must reect the widget’s subfolder. For example, a custom widget in /cp/customer/development/widgets/custom/
input must declare its namespace as Custom.Widgets.input.

Library Namespaces  
Custom libraries are in the Custom/Libraries namespace.

This example is from the library in /cp/customer/development/libraries/Sample.php:

<?php
 namespace Custom/Libraries;
 class Sample 
 {
 . . . 
}

Custom libraries are not required to extend from anything. Also they are not allowed to be in a subfolder, which means
the namespace does not have to match the le system path required for custom widgets and models. All libraries
appear under the Custom/Libraries namespace. Additionally, namespace requirements apply only when using the
framework functions (for example, using $this->load->library('Sample')) to load and instantiate the library. If you
include the library manually using include/require, the Customer Portal cannot enforce the naming conventions.

JavaScript Namespacing  
Namespaces prevent naming conicts in Customer Portal reference implementation code and your custom code.

All JavaScript code must be namespaced. There must not be any JavaScript variables or functions that are not
contained within a namespace.
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JavaScript namespaces are designated with dot notation, for example, RightNow.Widgets and Custom.Widgets. Customer
Portal reference implementation code uses the RightNow.* namespaces, but the custom code you develop must use
Custom.* namespaces.

Note:  If a namespace segment contains only two characters, both need to be capitalized, for example,
Custom.UI. If the namespace segment has three or more characters, Pascalcase must be used, for example,
Custom.Urnl.

Function Namespaces  
There are a number of JavaScript namespaces for common functions in the reference implementation.

These are common functions namespaces:

• RightNow.Ajax—Functions that pertain to AJAX requests or AJAX request handling.

• RightNow.Event—Event logic for Customer Portal, including the functions used to create, re, and subscribe to
events, as well as process this information.

• RightNow.Interface—Message base and conguration base values that are transferred into JavaScript and
message base and conguration base functions.

• RightNow.JSON—Functions to encode and decode JSON.

• Rightnow.Prole—Variables for the logged-in user’s prole and functions that deal with the prole.

• RightNow.Text—Functions that apply to string manipulation. This also contains an Encoding subclass that is
used for encoding and decoding.

• RightNow.UI—Functions that interact with the DOM. This class also contains a Dialog subclass that is used for
any dialog functions and a Form subclass for form submission functions and variables.

• RightNow.Url—Functions that pertain to URL retrieval, addition, modication, deletion, and redirection.

• RightNow.Widgets—All widget JavaScript instances on the page and functions to interact with these instances.

Note:  These are internal namespaces and must not contain custom code. See the Customer Portal Framework
Version 3.3 JavaScript API reference documentation.

How to Access Customer Prole Data  
You can access a customer’s prole information using JavaScript so you don’t need to gather that information in a
widget controller.php le and pass it to JavaScript manually.

The available prole data includes whether the customer is logged in, email, rst name, last name, full name, contact ID,
and previously seen email.

These widgets should use RightNow.Prole in the logic.js le for their prole data:

• chat/ChatLaunchBuon/controller.php

• notications/AnswerNoticationIcon/controller.php
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• social/CommunityPostDisplay/controller.php

These methods are available:

• RightNow.Prole.isLoggedIn()

• RightNow.Prole.previouslySeeEmail()

• RightNow.Prole.rstName()

• RightNow.Prole.lastName()

• RightNow.Prole.fullName()

• RightNow.Prole.contactID()

• RightNow.Prole.emailAddress()

Note:  This API does not automatically add the Japanese name sux label when retrieving the fullName
property. If you need this label, you can manually append the call to:

RightNow.Interface.getMessage("NAME_SUFFIX_LBL"):

Create a Custom Widget  
You can plan and create a custom widget.

1. Determine whether there is an existing standard or custom widget that provides similar functionality to what
you want, and make a note of its name and location.

2. If there is an existing widget with similar functionality, you can extend it. Work through the Guidelines for
Extending an Existing Widget table to determine the components and functionality you require for the widget
and supporting code.

3. If there is no suitable existing widget, work through the Creating a Brand New Widget table to determine the
components and functionality you require for the brand new widget.

4. Use the widget builder to create your widget.
This creates all the widget les, which include skeleton code you can use as a starting point for customization.

5. Add the custom code you require to the les produced by the widget builder.
6. Customize the CSS le as required.
7. Create any additional code you require to support your custom widget.

Note:  Remember that you can change the look and feel of a widget simply by modifying the CSS, and
this may be all the customization you require.

Guidelines for Extending an Existing Widget  
There are many decisions to make when planning your site and whether to use existing widgets.
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Planning decision Why you might need this… See related topics

Does your custom widget need its own
controller or can it use the parent’s controller?
 

You might want to override functions from the
parent widget, or you might need to add new
functions.
 

The Custom Widget Controller File
 

If your widget has its own controller, does it
need its own AJAX handling capability, or can it
use that of the parent widget?
 

If you need to get data from the server and
the parent widget does not get the data you
require, you can add AJAX handling to your
custom widget.
 
However, if you have multiple widgets making
the same AJAX request, you should use
the AJAX handling capabilities of a custom
controller.
 

Overview of Making AJAX Requests to the
Server
 
 

Does your custom widget need its own view or
can it use the parent’s view?
 

You might want to customize the view by
adding additional HTML within <rn:block>
elements in the view.php or view.ejs le
generated by the widget builder.
 

The Extended Widget View
 

If the new widget has its own view, will
the parent widget’s view be extended or
overridden?
 
Overriding means that the view and JavaScript
of the parent are ignored and those of the new
widget are used instead.
 

You might want to override if you need a view
and logic le that are very dierent from those
of the parent widget.
 
If the parent widget’s view is extended, the new
custom widget is automatically updated when
nano changes are made to the parent widget.
This is the recommended option.
 
If the parent widget’s view is overridden, you
must manually update the custom widget to
take advantage of any future changes to the
parent widget.
 

How You Override Widget View and JavaScript
Files
 

Do you want to include the parent’s CSS in your
custom widget’s CSS le.
 

If the parent’s CSS is included, your custom
widget automatically inherits all of the default
styling. However, you can still specify style
changes that apply only to the new widget
without aecting the parent widget.
 

Extended Widget CSS
 

Does your custom widget need its own
JavaScript (logic.js le) or can it just use the
parent’s JavaScript?
 

You might want to override properties and
functions from the parent widget, or you might
need to add new functions.
 
You might want to subscribe to form eld
events, report events, or other events.
 
Remember that if you override the parent’s
view, the parent’s JavaScript is overridden as
well.
 

Extended Widget Logic Files
 
 
Form Field Events
 
 
Report-Filtering Widgets
 

Which YUI modules do you need for the
widget?
 

A number of default YUI modules are loaded
automatically, but you may want to specify
additional modules.
 

YUI Components
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Planning decision Why you might need this… See related topics

Do you need JavaScript templates (in a
view.ejs le)?
 

You might use EJS templates if you need to
dynamically render views.
 
You can customize the view by adding
additional code within <rn:block> elements
in the new widget’s view.ejs le.
 

Embedded JavaScript and Template Files
 

Do you need to add additional aributes or
remove aributes?
 
What are the names and default values of any
additional aributes, and are they required?
 

Aributes are inherited from the parent widget,
 but you may want to add additional aributes
or remove inherited aributes. You may also
want to override aributes to set dierent
default values. For example, some widgets
have a source_id aribute and you can change
its default value to specify a dierent search
source.
 
If your widget is to have its own AJAX handling
capability, you need an AJAX endpoint
aribute, and this is added by the widget
builder.
 

Widget Info Files
 
 
Additional Search Sources and Report Widgets
 

What is the description of the widget?
 

You add a description of the widget’s purpose
when you use widget builder and this is added
to the info.yml le for the widget.
 

Widget Info Files
 

Do you need to specify any additional URL
parameters?
 

URL parameters are inherited from the parent
widget, but you may want to add additional
parameters.
 
You must supply a name, description, and
example for each parameter when using the
widget builder.
 

Widget Info Files
 

Which JavaScript modules will your widget use?
 

Your widget may have a dependency for
standard or mobile JavaScript libraries.
 

Widget Info Files
 

Will your custom widget contain other widgets?
 

Your widget may need to contain other widgets
within its view, as long as there is PHP logic
within the view.
 
You must add this information manually to the
info.yml le.
 

Widget Info Files
 

Where will you add your custom widget, that is,
 on which pages and where on the page?
 

You must determine which pages require the
new widget, and where exactly the widget is
added on the page.
 
There may be constraints on where you can add
the widget. For example, a widget that extends
RightNow.Field must be placed inside an HTML
<form> element on the page that includes the
widget.
 

 

Do you need to develop a new custom model?
 

You might need to create a custom model if you
require data from the server that you cannot

Overview of Creating Models
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Planning decision Why you might need this… See related topics

obtain from existing model function calls.
This may be necessary, for example, if you are
adding new custom objects.
 
Consider whether adding a hook to an existing
custom model would be sucient for your
needs.
 

 
Creating a Custom Model
 

Do you need to add any hooks?
 

You can use hooks, for example, to modify
data, perform custom validation, and return
customized error messages to display to the
user.
 

Adding Hooks
 

Do you need to develop a new custom
controller?
 

You might need to create a custom controller
if you have multiple widgets making the same
AJAX request.
 
You might also need a custom controller if you
are creating a new custom model.
 

Creating Controllers
 
 
Custom Controllers
 

Guidelines for Creating a Brand New Widget  
There are many decisions to make when planning your site and whether to create new widgets.

Use this table to determine which components and functionality you require for a new custom widget that does not
extend from another widget.

Note:  You need at least one of the controller, view, and logic components in a widget.

Planning decision Why you might need this… See related topics

Does your custom widget need a controller? You will need a controller:
 

• If you need to get data from the database
and pass it back to the view.

• If you want the widget to do its own AJAX
handling, as the controller contains the
AJAX endpoint.

If your new widget has a controller, does it need
its own AJAX handling capability?

You might need AJAX handling if you want
to customize the date sent in the request or
received in the response from the server.

Overview of Making AJAX Requests to the
Server

Does your custom widget need a view? You will usually require a view, as the view
provides the HTML for the widget and displays
content including data from the server.
In some cases, however, widgets can display
all their content within a dialog that does not
appear when the widget is loaded. In this case,
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 the view is dynamically added purely through
JavaScript.
 

Does your custom widget need JavaScript
(logic.js le)?

You will need JavaScript if:
 

• You need to include display logic.

• You need to subscribe to and re events,
 for example, form eld events and report
events.

• Your widget is doing its own AJAX
handling, as AJAX requests are made from
the JavaScript.

Form Field Events
 
 
Report-Filtering Widgets
 
 
Overview of Making AJAX Requests to the
Server
 

Which YUI modules do you need for the
widget?
 

A number of default YUI modules are loaded
automatically, but you may want to specify
additional modules.
 

YUI Components
 

Do you need JavaScript templates (in a
view.ejs le)?
 

You might use EJS templates if you need to
dynamically render views.
 

Embedded JavaScript and Template Files
 

Do you need a base CSS le for the widget.
 

You need a base CSS le if you require CSS
rules to structure the widget or so that it
functions correctly.
 
A base CSS le and presentation CSS le are
created automatically when you use the widget
builder, but neither of these les are required.
 

Do you need a presentation CSS le for the
widget?
 

You need a presentation CSS le if you want to
add specic styling rules for the widget that are
not covered within the site CSS le.
 

Which aributes do you need to specify for
your widget?
 
What are the names and default values, and are
they required?
 

If your widget is to have its own AJAX handling
capability, you need an AJAX endpoint
aribute, and this is added by the widget
builder.
 

Widget Info Files
 

What is the description of the widget?
 

You add a description of the widget’s purpose
when you use widget builder. This description is
added to the info.yml le for the widget.
 

Widget Info Files
 

Do you need to specify any URL parameters?
 

Your new widget may require URL parameters.
If so, you must supply a name, description, and
example for each parameter when using the
widget builder.
 

Widget Info Files
 

Which JavaScript modules will your widget use?
 

Your widget may have a dependency for
standard or mobile JavaScript libraries, or it
may have no JavaScript requirements.
 

Widget Info Files
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Will your custom widget contain other widgets?
 

Your widget may need to contain other widgets
within its view, as long as there is PHP logic
within the view.
 
You must add this information manually to the
info.yml le.
 

Widget Info Files
 

Where will you add your custom widget, that is,
 on which pages and where on the page?
 

You must determine which pages require the
widget, and where exactly the widget is added
on the page.
 
There may be constraints on where you can add
the widget. For example, a widget that extends
RightNow.Field must be placed inside an HTML
<form> element on the page that contains the
widget.
 

 

Do you need to develop a new custom model?
 

You might need to create a custom model if you
require data from the server that you cannot
obtain from existing model function calls.
This may be necessary, for example, if you are
adding new custom objects.
 
Consider whether adding a hook to an existing
custom model would be sucient for your
needs.
 

Overview of Creating Models
 
Creating a Custom Model
 

Do you need to add any hooks?
 

You can use hooks, for example, to modify
data, perform custom validation, and return
customized error messages to display to the
user.
 

Adding Hooks
 

Do you need to develop a new custom
controller?
 

You might need a custom controller if you
have multiple widgets making the same AJAX
request.
 
You might also need a custom controller if you
are creating a new custom model.
 

Creating Controllers
 
Custom Controllers
 

Custom Models  
You can customize a standard model’s functionality by creating a custom model that extends from a standard model.

Customizing a model can be useful for modifying the behavior of all the widgets that make calls to that particular
model.

You may nd that adding a hook is sucient for your customization purposes. Hooks provide custom code associated
with particular events that let you extend Customer Portal functionality by calling a function in a custom model. You can
use hooks, for example, to modify data, perform custom validation, and return customized error messages to display to
the user.
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You might create a brand new custom model if you need to access custom data, for example, a custom object or data
that is not kept in the knowledge base. In this case, the custom model extends directly from the Base model.

Other Customer Portal Customizations  
You can create other customizations using widgets and models.

In addition to creating custom widgets and custom models, there are some other types of customization available for
the Customer Portal:

• Custom controller—Custom controllers are mostly required to create a new AJAX endpoint, either to pre-
process data before it goes to a standard model, or to allow the sending of the data to a custom model.

• Custom libraries—If you use the same custom code in multiple places, you may want to avoid duplication of the
code in a number of models or controllers and therefore use custom libraries to organize the code.

• Custom helpers—Although it is unlikely that you will use custom helpers, you can add them to the folder /cp/
customer/development/helpers.

• The autoload javascript le—You can put common functions and event declarations in this le so they get
loaded on every page.

• Error pages—You can customize error pages that are displayed when your site is undergoing an upgrade.

Abuse Detection in Code  
The code in your custom models or custom controllers may be susceptible to abuse, such as SQL injections and other
aacks when certain conditions exist.

Standard models and standard controllers call the native abuse detection methods, so if you use standard controllers
with standard models, you do not need to customize your code with abuse detection calls. However, if your custom
code performs any direct API calls for database updates or back-end actions, for example, to create or update incidents
or contacts, log in a user, or perform answer retrieval, it must contain abuse detection code. Customer portal code
generally calls check() in most places, including from controllers. However, custom models should call the /RightNow/
Libraries/AbuseDetection::isAbuse() function instead of check() to prevent the model from exiting with JavaScript code
for invoking a CAPTCHA. The isAbuse() function returns a ResponseObject error that can be handled appropriately.

In models, use isAbuse() to prevent the model call from exiting with JavaScript code. From other sources, including
controllers, use check() to ensure that the CAPTCHA is invoked. If your custom models are being called only from
custom controllers, the check() needs to be called once in the request, so it can reside only in the controller.

if (AbuseDetection::isAbuse($formToken)) {
 return false;
}
OR
if (!AbuseDetection::isAbuse($formToken)) {
 // Code to create an incident
}

If abuse is detected, a CAPTCHA screen is displayed for the user to ll out. Failing to call the check() function can result
in Connect PHP calls throwing an exception.
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How You Create Abuse Scenarios  
The Customer Portal uses web form security on the FormSubmit widget to automatically require human validation
through the use of a CAPTCHA when abuse is suspected.

If your custom code performs database calls, you must call the /RightNow/Libraries/AbuseDetection::isAbuse( )
function to detect abuse.

An abuse scenario is hard to create deliberately for testing purposes, so the Customer Portal includes a cookie that
makes your site behave as if it is under abuse when the cookie is set. It works only in development mode for testing
purposes, so it does not aect customers on your production site.

Other Customer Portal Security Features  
There are a number of security enhancements available.

In addition to the abuse detection cookie, these security enhancements are included in the Customer Portal.

• PTA encryption—The encryption scheme for pass-through authentication supports the use of a salt and IV
(initialization vector), which allow more secure encryption of PTA strings. Two conguration seings let you
specify the salt or IV values to use during decryption: PTA_ENCRYPTION_SALT and PTA_ENCRYPTION_IV.

• File aachment whitelisting—The Customer Portal hooks pre_aachment_upload and
pre_aachment_download let you indicate the mime types you want to support and allowing you to prevent
automatic execution of certain types of downloaded les.

• HTTP Strict Transport Security (HSTS) support—If your customer portal uses SSL only (that is, if
SEC_END_USER_HTTPS is enabled), your customers will always access the site using HTTPS even if they type
hp in the browser address bar. This security feature is supported in Google Chrome, Mozilla Firefox 4, and the
NoScript Firefox extension.

The Widget Builder  
You can create widgets either by extending an existing standard or custom widget, or by writing a new widget.

You can use the widget builder to create the les you require for a new or extending widget, and then add code as
required to complete your custom widgets.

File Purpose

info.yml
 

Provides information about a widget, its aributes, and its dependencies. See Widget Info Files.
 

controller.php
 

Contains code to coordinate the widget, including calls to models to access the database and code to
pass data to the view. A custom widget can have its own controller or simply use the controller of its
parent widget. A custom widget controller can include its own AJAX request handling capability or
inherit the capability from its parent widget. See The Custom Widget Controller File.
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File Purpose

 

view.php
 

Contains the HTML required to display the widget. A custom widget can have its own view, or simply
use the view of its parent widget. See The Extended Widget View.
 

view.ejs
 

Contains JavaScript templates used by the widget to render dynamic views. See Embedded JavaScript
and Template Files.
 

logic.js
 

Contains display logic, event-handling, and other logic. A custom widget can have its own logic le,
or simply use the logic le of its parent widget. A custom widget logic le can override properties and
functions of its parent widget. See Extended Widget Logic Files.
 

base.css
 

Contains base CSS to structure the widget. See Extended Widget CSS.
 

WidgetName.css
 

Contains presentation CSS, which controls the appearance of the widget. See Extended Widget CSS.
 

preview/ preview.png
 

Displays an example of what the widget will look like when you add it to a page.
 

While a new custom widget is not required to have its own controller, view, and logic components, your custom widgets
will need at least one of these components.

Widget Info Files  
Every widget must have an info.yml le, wrien in the YAML format, in its directory. This le species all of the widget’s
important details.

When you use the widget builder to create a new widget, an info.yml le for the new widget is automatically created.
You may need to edit this le as you make further customizations to the widget.

Functionality Example

version:

Contains a string consisting of the major
and minor version number of the widget.
This section is required.
 

version: “1.0”

requires:

Lists the Customer Portal framework and
technology dependencies for the widget.
 

requires:
 framework: "3.0"
 jsModule: [standard, mobile]
 yui: [panel, autocomplete, autocomplete-highlighters]

attributes:

Lists aributes for the widget. Aributes
inherited from a parent widget are
included only if they have been modied.
 

attributes:
 label_heading:
 name: Heading label
 description: Label for the heading
 type: string
 default: Welcome back!
 display_option:
 name: Display option
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 description: How to display the widget
 options: [subtle, bold, obnoxious]
 default: subtle

extends:

Species the parent widget of the custom
widget.
 

extends:
 widget: "standard/utils/SocialBookmarkLink"
 components: [php, css]
 overrideViewAndLogic: true

info:

Contains an associative array of
information about the widget.
 

info:
 description: Form for submitting complaints and feature requests.
 urlParameters:
 a_id:
 name: Answer ID
 description: ID of the answer to display
 example: a_id/123

contains:

Optional section used when the widget
contains one or more other widgets
within its view. You must add this section
manually because the widget builder does
not generate it. The view must contain
PHP logic in order for a widget to contain
other widgets.
 

contains:
 - widget: standard/input/SelectionInput
 versions: ["1.0"]
 - widget: standard/input/DateInput
 versions: ["1.0"]
 - widget: standard/input/TextInput
 versions: ["1.0", "1.1"]

Reserved Words  
Certain common elds used in Customer Portal, especially ones you should not alter or directly input, are reserved and
not valid.

The getValidationList() function within CleanseData.php contains a list of reserve words that are validated in a specic
format.

How You Extend Existing Widgets  
A widget can extend an existing standard or custom widget. A widget can have only one parent widget.

Instead of copying standard or custom widget code, which is a tedious and error-prone process, use the widget builder
to create a custom widget that extends from another widget. You specify these criteria.

• The components (controller, view, JavaScript, and CSS) to extend.

• Whether the controller does any AJAX handling.

• Whether to extend or override the parent widget’s view.

• Whether to include the parent widget’s CSS.

• The YUI modules you want to have loaded on any page that contains the widget and then passed to the
widget’s constructor.

• Whether you require a template, which lets you dynamically render content within the parent’s JavaScript view
le.

• Any new aributes for the widget.

1316



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

• Any changes to aributes inherited from the parent widget.

• Additional information including a description, the URL parameters for the widget, and the JavaScript
compatibility information.

The widget builder generates custom code with defaults and placeholders that you can then tailor to your requirements.

Extend an Existing Widget  
You can extend an existing widget using the widget builder.

1. In the widget builder, select Extend the functionality of an existing widget.
2. Specify the name of the new widget and the widget it is extending from.
3. Specify the widget components to be used.
4. If the widget has its own controller, specify whether it will do any AJAX handling.
5. If the widget has its own view, specify whether the parent widget’s view is to be extended or overridden and

whether the parent widget’s CSS is to be included.
6. If the widget has its own JavaScript, specify the YUI modules to be used with the widget.
7. If the widget has its own JavaScript, specify whether templates are required.
8. Add any new aributes that are required in addition to the aributes inherited from the parent widget.
9. Add additional details as required, including a description of the widget, any URL parameters, and JavaScript

framework compatibility.
If the parent widget of your new widget contains URL parameters, they are listed as inherited parameters for
the new widget.

Related Topics
• The Extended Widget View

• The Custom Widget Controller File

• Extended Widget Logic Files

• Extended Widget CSS

The Extended Widget View  
When a widget extends another widget, the parent widget’s view.php le is used for rendering. If the new widget has a
view.php le of its own, then the blocks that are dened in the new view are added to the parent widget’s view.

A widget’s view le may contain <rn:block> elements as shown in this example.

<rn:block id="postFeedbackInput"/>

Every <rn:block> element within a widget has a unique ID that describes its context. These blocks are customization
hook points for extending the widget.

For example if the parent view.php le contains:

<rn:block id="main"/>
<div><?= $this->data['js']['moreresults'] ?></div>

and the extending view contains:

<rn:block id="ParentWidgetName-main">
 <span><?= $this->data['js']['results'] ?></span>
</rn:block>

the resulting view is:
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<span><?= $this->data['js']['results'] ?></span>
<div><?= $this->data['js']['moreresults'] ?></div>

If the extending widget does not have a view.php le, then the parent widget’s view.php le is used.

In a similar way, blocks of content within the parent JavaScript view le (view.ejs) can be modied.

How You Override Widget View and JavaScript Files  
In most cases, extending the parent widget’s view and customizing the new widget’s view with the <rn:block> element is
sucient, and this is the recommended best practice.

If a custom widget extends a widget’s controller, but has a completely dierent view and corresponding logic le, you
can specify the overrideViewAndLogic value in the custom widget’s info.yml le. This is also an option in the widget
builder. The parent widget’s view.php and logic.js les are then ignored, and instead these les from the custom widget
are used. Specifying an override of just the view or just the logic le is not supported, because the DOM and JavaScript
are tightly coupled.

This example from the extends section of an info.yml le demonstrates how the php component of the DataDisplay
widget is being used, but the view and logic les are referenced solely from the extending widget.

extends:
 widget: standard/output/DataDisplay
 components: php
 overrideViewAndLogic: true

When overrideViewAndLogic is specied, the component values view and js must not be present in the components
key in info.yml, otherwise an error is thrown when aempting to use the widget.

The Custom Widget Controller File  
A custom widget that extends another widget can have its own controller.php le that extends the other widget’s
controller, or it may simply use the parent widget’s controller, which will be loaded and ready to use.

If the new widget does not have its own controller, its view and logic les will use the default properties and data dened
in the parent’s controller.

The new widget can override methods (other than private methods) from the parent widget. When you use the widget
builder to create a widget that extends from another widget, the controller.php le that is generated lists the methods
that can be overridden.

An example of a new controller.php le is as follows.

 <?php
 namespace Custom/Widgets/sample;
 class MySocialBookmarkLink extends /RightNow/Widgets/SocialBookmarkLink {
 function __construct($attrs) {
 parent::__construct($attrs);
 }
 function getData() {
 // Add preprocessing code here...
 parent::getData();
 // Add postprocessing code here...
 }
 }

As shown in the example, custom widgets must use the Custom/Widgets/widgetParentFolder namespace, for
example, Custom/Widgets/sample or Custom/Widgets/feedback.
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The widget’s class name must be the same as the widget’s folder name.

Widgets extending standard widgets must have a constructor and must call the parent’s constructor. The custom
extender can add, modify, or remove data before or after the parent widget controller’s getData() method is called.
However, widget controllers are not required to call the parent’s getData() methods.

The widget automatically inherits any AJAX-handling functionality of its parent. However, the extending widget can also
have its own AJAX handler.

Custom Controllers  
You can create custom controllers that extend from the /RightNow/Controllers/Base class. You cannot extend from any
other controller class.

Custom controllers are mostly required to create a new AJAX endpoint, either to pre-process data before it goes to a
standard model, or to allow the sending of the data to a custom model.

Extended Widget Logic Files  
A custom widget that extends another widget can have its own logic.js le that extends from the parent widget’s logic
le, or it can use the parent widget’s logic le, which will be loaded and ready to use.

If the new custom widget has its own logic.js le, the code must indicate that it is extending from another widget, for
example:

RightNow.namespace('Custom.Widgets.MySocialBookmarkLink');
Custom.Widgets.MySocialBookmarkLink =
 RightNow.Widgets.SocialBookmarkLink.extend({

The Constructor Function in logic.js Files  
You can use the constructor function to extend logic.js les.

As an example, the SocialBookmarkLink widget extends from RightNow.Widgets.

})
RightNow.Widgets.SocialBookmarkLink = RightNow.Widgets.extend({
 constructor: function() {
 // Do things on page load here (constructor)
 },
 sbl: function() {
 }
});

The rst function dened in the object passed to RightNow.Widgets.extend() is named constructor. This function is
run immediately when the widget is instantiated (during onDomReady event). Three parameters are passed to the
constructor method.

• The data parameter:

◦ attrs—Widget aributes.

◦ js—Members set in the widget’s controller.

◦ info—Name and path, for example.

• The instanceID parameter.

• The Y parameter, which is an instance of YUI.
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Before the constructor is called, several helpful actions are performed. The RightNow.Widget that all widgets extend
from has already called a base function that’s called before the extending widget’s constructor is called.

This base function performs these actions:

function helper(data, instanceID, Y) {
 this.data = data;
 this.instanceID = instanceID;
 this.Y = Y;
 this.baseDomID = "rn_" + this.instanceID;
 this.baseSelector = "#" + this.baseDomID;
 this.getStatic = function(){ return _getObject(this.data.info.class_name);};
}?

This means that every widget that extends from RightNow.Widget does not need to set instance variables to what was
passed in, because that action has already been performed. All standard RightNow widgets use rn_ + widgetInstanceID
as a convention for IDs in HTML elements, therefore seing the baseDomID and baseSelector provides helpful instance
variables so that you do not need to duplicate rn_ + this.instanceID + _SomethingElse multiple times in widget
JavaScript code.

You can dene all other widget methods or instance variables within the object passed to RightNow.Widgets.extend()
using the standard key: value paradigm. When code is executing inside a widget method, it can reference other methods
and instance variables as it normally does (for example, this.someOtherMethod, this.instanceID.)

Static Properties  
RightNow.Widgets.extend() accepts two parameters, the constructor function and an optional second parameter, which
also must be an object. However, with this second parameter, all key-value properties declared are added as static
properties of the widget.

For example:

 RightNow.Widgets.SocialBookmarkLink = RightNow.Widgets.extend({
 constructor: function(data, instanceID, Y) {
 },
 sbl: function() {
 }
 }, /** End of the first parameter **/
 {
 aStaticProperty: "sbl",
 aStaticFunction: function() { … }
 });
 RightNow.Widgets.SocialBookmarkLink.aStaticProperty; // "sbl"
 RightNow.Widgets.SocialBookmarkLink.aStaticFunction();

All static properties are then available on the widget’s static class, RightNow.Widgets.WidgetName.

If a widget extends another widget then any static properties dened for the parent can be overridden by the child.

Parent Properties in logic.js Files  
An extending widget automatically gains access to all of the properties and methods of the parent widget, and the
extending widget can change the behavior of any of these methods.

In the object passed to parent.extend() there is a special key, overrides, which allows the overriding of properties and
methods dened in the parent.

parent.extend({
 overrides: {
 constructor: function(){...},
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 aMethod: function(){...},
 aProperty: 23
 },
 anotherMethod: function(){...}
})

Any property dened in the object denoted by the overrides key overrides the property of the same name in the parent.

Every function dened inside overrides that has a parent function of the same name automatically gets a this.parent()
member that allows the function to call the parent function that it is overriding.

Every property that is dened inside overrides is essentially “aened out”, meaning that other widget methods still
reference them normally using this.propertyName. So from the example above, aMethod is able to call anotherMethod
as expected using this.anotherMethod(), and anotherMethod is able to call aMethod as expected using this.aMethod().

As an example, in the parent:

RightNow.Widgets.SocialBookmarkLink = RightNow.Widgets.extend({
 constructor: function() { ... },
 _onClick: function() { ... },
});

And in the extending widget:

Custom.Widgets.Bookmark = RightNow.Widgets.SocialBookmarkLink.extend({
 overrides: {
 constructor: function() {
 this.parent(); // Calls constructor above
 // Do something else...
 this.showDialog();
 },
 _onClick: function() {
 this.parent(); // Calls _onClick above
 // Do something else...
 this.hideDialog();
 }
 },
 showDialog: function() {
 // Do something...
 this._onClick();
 },
 hideDialog: function() {
 // Do something...
 }
});

If a property is dened within overrides that does not have the same name as any parent property, then the property
simply exists as any other widget property.

parent.extend({
 overrides: {
 constructor: function() {...} 
 // overrides parent's constructor
 doesntExistOnParent: true
 },
 heyNow: function() {
 this.doesntExistOnParent; // true
 }
});

If a property with the same name as a parent property is specied outside of the overrides structure, the property is still
accessible to the rest of the widget itself, as normal, but the property does not override the parent property of the same
name.
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parent = RightNow.Widget.Extend({
 constructor: function() {
 ...
 something.on('click', this.onClick, this);
 },
 onClick: function() {
 alert('parent');
 }
});
child = parent.extend({
 overrides: {
 constructor() {
 ...
 this.parent();
 this.onClick(); // 'child' alerts
 }
 },
 onClick: function() {
 typeof this.parent === 'undefined'; // true
 alert('child');
 }
});

In the example, the extending widget accesses its own onClick() method normally, but when the domElement
subscribed to in the parent is clicked, the parent’s onClick method is still called, because it was not overridden by the
extending widget.

Again, to override and call into a parent method, the overriding method must be contained within the overrides
structure.

child = parent.extend({
 overrides: {
 constructor() {
 ...
 this.parent();
 this.onClick(); // 'child' alert is followed by a 'parent' alert
 }
 },
 onClick: function() {
 typeof this.parent === 'function'; // true
 alert('child');
 this.parent();
 }
});

YUI Components  
An instance of YUI is passed as the third parameter to the constructor function in logic.js les, and widgets can use this
YUI instance to interact with YUI.

YUI 3 is intended to be used in discrete, compartmentalized, modularized components within applications. This is
exactly how widgets can be described, so YUI is ideal to use with them.

this.Y.one(this.baseSelector);
this.Y.UA.ie > 9);

Including the YUI 3 script tag on a page creates a minimal YUI() function that returns an object with a few functions and
properties. YUI 3 expects callers to list out any sub-module dependencies that you intend to use with your code. The
code that uses the sub-modules is a callback function that YUI executes when it has created a new YUI instance with all
of those modules as part of that instance. It provides that instance as the rst parameter to the callback function.
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By default, each YUI instance has several components available as rst-level modules, including:

• DOM

• Node

• Anim

• Event

• History

• IO

Widgets declare any YUI module dependencies by listing the modules in their info.yml le.

...
requires:
 ...
 yui: [slider, autocomplete, autocomplete-highlighters]
...

Any standard YUI 3 modules are accessible to widgets that declare such module dependencies.

RightNow.Widgets.sbl = RightNow.Widgets.extend({
 constructor: function(data, instanceID, Y) {
 Y.Slider(); Y.Plugin.Autocomplete;
 }
});

In some cases, a widget might be used in both mobile and desktop environments, but for each of those environments
there might be dierent requirements. Also, as additional JavaScript on a page incurs a greater performance impact on
a mobile device, you may decide not to include certain components for mobile (as long as the widget code appropriately
handles the omission of certain YUI components). In this case, in the info.yml le you can specify YUI requirements for
each jsModule entry.

...
requires:
 yui:
 standard: [panel, autocomplete]
 mobile: [overlay]
...

In this example, if the widget is used on a page where standard is the jsModule value (the default), the widget instance
receives a YUI instance including the Panel and Autocomplete YUI components. If the same widget is used on a page
where mobile is the jsModule value, then it receives a YUI instance including just the Overlay component. This lets
you use the same widget for both environments without having to build an almost identical mobile widget. However,
requiring very dierent YUI components for standard and mobile environments is not recommended because it can
lead to convoluted code and bugs.

A more common scenario is to simply omit certain requirements for a mobile environment from the info.yml le.

...
requires:
 yui:
 standard: [overlay]
...

In this case, rather than the widget checking for a particular browser user-agent, it can then simply not provide a feature
or provide the feature in a dierent way. For example in the widget’s logic.js:

if (this.Y.Overlay) {
 // Do something with an overlay
}
else {
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 // Do something without an overlay
}

Extended Widget CSS  
If there is a base.css le within a widget’s directory, then it is used. If there is a presentation CSS le with the same name
as the widget directory under /cp/customer/assets/themes/standard/widgetCss, then it is used.

If a widget extends another widget and you want the CSS for the parent widget to also be included, you can specify it as
another component in the info.yml le.

extends:
 widget: "standard/utils/SocialBookmarkLink"
 versions: "3.1"
 components: ["php", "css"]

The resulting CSS included on the page is ordered with the parent CSS rst, followed by the extending child CSS.

<style>
 /* Parent base.css */
 /* Parent presentation CSS (SocialBookmarkLink.css) */
 /* MyWidget base.css */
 /* MyWidget presentation CSS (MyWidget.css) */
</style>

When a widget extends another widget, the names of both widgets are used for the top-most containing element’s class
name. In this example, MyWidget extends from the SocialBookMarkLink widget.

<div class="rn_SocialBookmarkLink rn_MyWidget" id="...">
 Widget contents
</div>

If the parent’s CSS is included, the widget automatically inherits all of the default styling. However, you can specify style
changes that apply only to the new extending widget without aecting the standard widget.

.rn_SocialBookmarkLink {
 /* Styles written here will affect the standard SocialBookmarkLink widget as well as any widgets that
 extend from it*/
}
.rn_SocialBookmarkLink.rn_MyWidget {
 /* Styles written here only affect the extending widget */
}

How You Create a Widget from Scratch  
You can use the widget builder to create new widgets.

You specify the components (controller, view, JavaScript) that the new widget has. A new widget must have at least one
of the components.

• For the controller, you can specify whether it does any AJAX handling.

• For the JavaScript, you can specify the YUI modules you want to have loaded on the page that contains the
widget and then passed to the widget’s constructor.

• For the JavaScript, you can specify whether you require a template, in other words, a view.ejs le.

• You can specify the aributes required for the new widget.

• You can also specify additional information including a description, the URL parameters for the widget, and the
JavaScript compatibility information.
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The widget builder generates custom code with defaults and placeholders that you can then tailor to your requirements.
The widget’s view.php le contains this div tag to simplify your coding work.

<div id="rn_<?= $this->instanceID ?>" class="<?= $this->classList ?>">
</div>

Create a Widget  
You can use the widget builder to create a new widget.

1. In the widget builder, select Create a brand new widget from scratch.
2. Specify the widget components that will be used.
3. If the widget has a controller, specify whether it will do any AJAX handling.
4. If the widget has its own JavaScript, specify the YUI modules to be used with the widget.
5. If the widget has JavaScript, specify whether templates are required.
6. Add aributes as required.
7. Add additional details as required, including a description of the widget, any URL parameters, and JavaScript

framework compatibility information.

Files are generated for the new custom widget. You can then add code to the les as required.

Overview of Making AJAX Requests to the Server  
Widgets can make their own AJAX requests to the server.

This is an overview of the process.

1. You specify the location of a handler for an AJAX request (the endpoint URL) through a widget aribute.
2. Before a widget makes a request, the logic.js le res an event, and subscribers to the event can customize the

data to be sent in the request.
3. The widget’s logic.js le makes the AJAX request and calls a handler method in the widget’s controller, passing

the necessary data for the request.
4. The handler method in the controller can access any parameters passed in the request and calls model

functions as required to return the output and results.
5. The widget’s logic.js le has a callback method for the response from the server.
6. After a widget receives a response, the logic.js le res an event, and subscribers to the event can customize

behavior, for example, to modify any of the data in the response.

Widgets and Event Firing  
Before a widget makes an AJAX request, it res an event.

Subscribers to that event can:

• Add, remove, or modify any data to be sent in the request.

• Cancel the AJAX request.

This code from a logic.js le shows an example of such an event.

var eventObject = new RightNow.Event.EventObject(this, {data: {
 w_id: this.data.info.w_id,
 a_id: this.data.js.answerID,
 rate: this._rate,
 email: this.data.js.email || this._emailField.value,
 message: this._feedbackField.value,
 threshold: this.data.attrs.dialog_threshold,
 options_count: this.data.attrs.options_count,
 submitfeedback: true,
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 handler: this.data.ajaxHandlers.submit_rating_ajax
}});
if(RightNow.Event.fire("evt_answerFeedbackRequest", eventObject)){
 RightNow.Ajax.makeRequest(this.data.attrs.submit_feedback_ajax, eventObject.data, {successHandler:
 this._onResponseReceived, scope: this, data: eventObject, json: true});
}

In this example, all of the data sent to the server is passed in the evt_answerFeedbackRequest event. Subscribers to that
event can modify any of that data. If a subscriber returns false, then the event is cancelled and the line containing
RightNow.Ajax.makeRequest is never reached.

How You Make AJAX Requests in the Widget JavaScript  
You can make AJAX requests using JavaScript.

Using the AnswerFeedback widget as an example, when customers rate an answer, the AnswerFeedback widget’s
logic.js le calls one of its JavaScript functions.

/**
* Submit data to the server.
*/
_submitFeedback: function() {
 var eventObject = new RightNow.Event.EventObject(this, {data: {
 w_id: this.data.info.w_id,
 a_id: this.data.js.answerID,
 rate: this._rate,
 email: this.data.js.email || this._emailField.value,
 message: this._feedbackField.value,
 threshold: this.data.attrs.dialog_threshold,
 options_count: this.data.attrs.options_count,
 submitfeedback: true,
 }});
 if(RightNow.Event.fire("evt_answerFeedbackRequest", eventObject)){
 RightNow.Ajax.makeRequest(this.data.attrs.submit_feedback_ajax, eventObject.data, {successHandler:
 this._onResponseReceived, scope: this, data: eventObject, json: true});
 }
}

In addition to the normal POST variables, there is also the instance number of the current widget (w_id).

The endpoint for the request (the value for the submit_feedback_ajax aribute) is specied by
this.data.attrs.submit_feedback_ajax. When the widget controller calls $this->setAjaxHandler, the aribute value is
changed to aribute value + widget path + name of handler method. So, for our example.

this.data.attrs.submit_feedback_ajax == "/ci/ajax/widget/standard/feedback/AnswerFeedback/
submitAnswerFeedback"

And therefore the request ultimately made is:

POST /ci/ajax/widget/standard/feedback/AnswerFeedback/submitAnswerFeedback
Data: w_id=12&a_id=57&rate=4&email=red@dog.com&threshold=2&options_count=4&submitfeedback=true

The widget path and handler name are appended onto the path on any value specied for AJAX-type aributes. So, if
the widget’s AJAX endpoint is changed, for example:

<rn:widget path="feedback/AnswerFeedback" submit_feedback_ajax="/cc/feedback">

The URL for the request that’s made is:

POST /cc/feedback/standard/feedback/AnswerFeedback/submitAnswerFeedback
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As already discussed, before the AJAX request is actually made, a synchronous event is red, along with the actual
contents of everything to be sent to the server. This means that any subscriber to the event is able to modify what is
sent to the server.

The widget species its own callback function for the server response. In the example, _onResponseReceived() species
that the results are to be JSON-parsed before the callback method is called.

Everything needed to route the AJAX request to the specic widget instance is in the AJAX request:

• The path to the widget (added implicitly by the framework).

• The name of the widget’s AJAX handling method (added implicitly by the framework).

• The Instance ID of the widget.

• The page containing the widget (captured as the hp_referer in the request).

With this information, the proper widget method can be called and instance-specic aributes can also be called, all as
part of handling the AJAX request.

There are a number of ways to customize the AJAX request.

• Changing the endpoint of the request—You can change the aribute value in the widget declaration on the
containing page.

• Changing how the request data is handled on the server—You can extend the widget controller and either
change the ajaxHandlers member to a uniquely named method, or modify the incoming and outgoing data by
implementing and wrapping the same method as the parent.

• Modifying the data sent in the AJAX request—You can subscribe to the event that is red before the AJAX
request is sent and modify the event object data.

AJAX Requests in the Widget Controller  
Any widget can dene an AJAX request handler method within its controller le. All standard widgets behave in this
manner.

This can be illustrated using the standard widget AnswerFeedback as an example. AnswerFeedback performs two AJAX
requests: one to record the answer rating that the user has given, and one to submit the user’s feedback message.

AnswerFeedback has an aribute for each AJAX request, and each aribute species the location of the handler
function for the AJAX request (the endpoint). Each instance of a widget can specify a unique AJAX endpoint, if required.
However, the aributes have a default path for the endpoint (/ci/ajax/widget), as shown in this excerpt from the
info.yml le.

submit_rating_ajax:
 name: Submit Rating AJAX
 type: ajax
 description: Endpoint to make the answer rating AJAX request to
 default: /ci/ajax/widget
submit_feedback_ajax:
 name: Submit Feedback AJAX
 type: ajax
 description: Endpoint to make the answer feedback AJAX request to
 default: /ci/ajax/widget

The default endpoint, ci/ajax/widget, means that the handler function in the widget’s controller is used for the AJAX
request.

This code excerpt illustrates the controller.php of AnswerFeedback.

namespace RightNow/Widgets;
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class AnswerFeedback extends /RightNow/Libraries/Widget/Base {
 function __construct($attrs) {
 parent::__construct($attrs);
 $this->setAjaxHandlers(array(
 'submit_rating_ajax' => 'submitAnswerRating',
 'submit_feedback_ajax' => array(
 'handler' => 'submitAnswerFeedback',
 'clickstream' => 'submitFeedback',
 )
 ));
 }
 function getData() {
 ...
 }
 static function submitAnswerRating($postData) {
 // record clickstreams interaction
 // echo out response
 }
 function submitAnswerFeedback($postData) {
 // pass thru to incident model
 // echo out response
 }
}

The widget has a setAjaxHandlers() method inherited from the widget Base class. The keys in the array passed to
setAjaxHandlers() are the names of the aributes relevant to the AJAX requests, which are used within the widget’s
JavaScript to make the request.

The values in the array are either:

• The string name of the widget’s method that will handle the AJAX request (submitAnswerRating() in the
example), or,

• An array with key values of:

◦ handler—The string name of the widget’s method that will handle the AJAX request
(submitAnswerFeedback() in the example).

◦ clickstream—The clickstream action to insert when this AJAX request occurs and the handler is called.

AJAX handling methods receive a single parameter that is an associative array of the GET/POST variables. The methods
can pull out parameters and route them through to models and then output the results.

The AJAX handling methods can be static or non-static. If an AJAX handling method is static, it cannot access any
instance properties of the widget, The method is in turn called as part of the AJAX request, therefore the widget is not
instantiated and the method is called statically. For example:

AnswerFeedback::submitAnswerRating($_POST);

If an AJAX handling method is non-static, then as the widget method is called on the AJAX request, the method is able
to access widget aributes that are specic to that instance of the widget.

Widgets and Firing an Event  
After a widget receives a response from the server, it immediately res an event.

Subscribers to that event can:

• Modify any of the data in the response.

• Perform any additional functionality, integration, or business logic based on the response.

• Cancel the event (so that the source widget ignores the server response).
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This code shows an example of such an event.

_onResponseReceived: function(response, originalEventObj){
 if(RightNow.Event.fire("evt_answerFeedbackResponse", {data: originalEventObj, response: response})) {
 // handle the server response
 }
}

Embedded JavaScript and Template Files  
You can use embedded JavaScript (EJS) in template les to dynamically render views.

This example code is from a view.ejs le.

<rn:block id="preList"/>
<ul id="<%= listID %>">
<% for (var i = 0; i < links.length; i++) { %>
 <rn:block id="listItem">
 <li><a href="<%= links[i].href %>"/><%= links[i].label %></a></li>
 </rn:block>
<% } %>
</ul>
<rn:block id="postList"/>

The highlighted code shows the JavaScript that is dynamically rendered when the widget logic le loads the view.ejs le
and the view is rendered.

Essentially JavaScript views allow separation of code and HTML for cleaner, dynamic widgets, and this can be
particularly important when you have a lot of HTML in the widget.

EJS is well suited for AJAX handlers in widgets. For example, if you have a widget that uses AJAX to fetch data from the
server, it can use EJS to dynamically update the UI on the page with the returned data.

As another example of how you can leverage EJS, you can put <h1><%= text %></h1> in a view.ejs le (or assign it to a
variable in JavaScript).

You then use this code in the logic.js le to render the view: // using inline
template or JS variable this.Y.one('#myTitle').set('innerHTML', new EJS({text:

RightNow.Widget[this.data.info.class_name].templates.view}).render(response);

Form Widgets  
Form widgets are those standard input widgets (for example, CustomAllInput, FormInput, and TextInput) or custom
widgets that extend from RightNow.Field that allow your customers to enter and update form information that gets
stored in incidents and contact records.

The RightNow.Field widget helper provides several useful functions that make processing form requests easier.
For example, the this.parentForm() function allows your custom code to subscribe to form eld events, to perform
validation of form input, check whether the form should be submied, and perform error handling as required.

Form Field Events  
All standard input widgets extend from RightNow.Field, and as your custom widgets can extend from those standard
widgets, they have access to the this.parentForm() function.

Your custom widgets can therefore subscribe to a form’s events.
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The events for this.parentForm() are:

• submit—Fired when the submit buon on the form is clicked. Subscribing code must perform validation during
this event.

◦ If a widget fails validation, it must report the error in the common error <div> element (whose id value
is provided in the EventObject passed to submit event subscribers). It must also return false from the
subscriber to the submit event (this noties the parent form that validation failed and the form must
therefore not be submied).

◦ If a widget passes validation, it must return a valid EventObject whose data is the value to be submied to
the server.

• send—Fired just before the form data is sent to the server. If a subscriber needs to cancel the event (and
prevent the form from being sent to the server), false must be returned.

• response—Fired as soon as a response is received from the server.

This logic.js le shows how events can be subscribed to.

RightNow.Widgets.sbl = RightNow.Field.extend({
 overrides: {
 constructor: function() {
 this.parent();
 ...
 this.parentForm().on("submit", this.validate, this)
 .on("send", this.seeIfFormShouldBeSubmitted, this)
 .on("response", this.lookAtResponse, this);
 },
 ...

A widget that extends RightNow.Field must be placed inside an HTML <form> element on a containing page, otherwise a
JavaScript error is thrown. There is no parent form, therefore placing an input eld outside of a form is invalid HTML.

Form widgets must contain only one FormSubmit widget inside the form. This is because the FormSubmit widget
extends from RightNow.Form, which is what sets the this.parentForm() for each Form widget.

Native Form Submissions  
There are cases when you may want a form to be submied natively (using either a POST or GET request) rather than
submied through an AJAX request.

If a declared HTML <form> element on a page has action and method aributes dened, and if the FormSubmit
widget does not have the on_success_url aribute dened (by default, it is not set), then the form’s action and method
aributes are honored. When the form passes validation (that is, all submit subscribers return successful EventObjects),
the form is submied natively.

<form action="/cc/myCustomSubmit" method="post">
 <rn:widget path="input/TextInput" name="Incident.Subject"/>
 ...
 <rn:widget path="input/FormSubmit"/>
</form>

Search Widgets  
Search widgets are those standard report-ltering or report-displaying widgets and custom widgets that extend from
RightNow.SearchFilter or RightNow.ResultsDisplay. Search widgets allow your customers to lter reports generated from
their searches or display those reports.
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RightNow.SearchFilter and RightNow.ResultsDisplay provide access to the this.searchSource() function, which allows
your custom code to subscribe to search events.

Report-Filtering Widgets  
There are a number of standard report-ltering widgets.

These standard report-ltering widgets extend from RightNow.SearchFilter.

• KeywordText

• SearchBuon

• SortList

• Paginator

• SearchTypeList

• OrgList

• ProductCategorySearchFilter

• DisplaySearchFilters

These standard report-displaying widgets extend from RightNow.ResultsDisplay.

• Multiline

• MobileMultiline

• Grid

• CombinedSearchResults

• CommunitySearchResults

Widgets, including your custom widgets, that extend SearchFilter or ResultsDisplay inherit this.searchSource(), which is
the interface to subscribe to events for searching.

• search—Fired when the search buon is clicked (red by the SearchBuon widget:
this.searchSource().fire("search", eo)).

All subscribers must return an event object with the lters property properly set to the current state of the lter.

• send—Fired just before performing the search (making the AJAX request or doing the page ip search).

If a subscriber returns false, then any other subscribers are still notied about the event, but the search is cancelled
when the event completes.

• response—Fired when a response is returned from the server. The event object contains the server’s response.

• reset—Fired to indicate that certain lters (that subscribe to this event) must reset their states to their initial
state.

• keywordChanged—Fired to indicate that the keyword changed.

• appendFilter—Fired when the event-ring code adds a lter to the group of the lters sent to the server.

• setInitiallters—Fired from ResultsDisplay widgets when the page is loaded. The event object sent contains an
allFilters-keyed object containing the initial state of all of the search lters on the page.

How Filter Widgets Respond to Multiple Reports  
A single keyword eld can be used for multiple reports on the same page. For report-ltering widgets, the report_id
aribute accepts a comma-separated string of report IDs.
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These report IDs are the ones that the search lter is applied to when a search is triggered.

<rn:widget path="search/KeywordText" report_id="176,197"/>
<rn:widget path="search/SearchButton" report_id="176,197"/>
<rn:widget path="reports/Multiline" report_id="176"/>
<rn:widget path="reports/Multiline" report_id="197"/>

In this example, the SearchBuon widget triggers a search on reports 176 and 197. The KeywordText widget responds to
that search event by passing back the user-entered search term. A search is then completed for both reports 176 and 197
using the same keyword.

Report-displaying widgets are limited to a single report_id value.

Using the inherited searchSource() function, widgets with multiple report IDs can respond to search events either for
individually reports or multiple reports. For example, for a widget with report_id="176,197":

...
/* When a search is triggered for either report 176 or report 197 then myHandlerFunction is called */
 this.searchSource().on("search", this.myHandlerFunction, this);
 ...
/* When a response comes back for report 176 then myResponder is called */
 this.searchSource(176).on("response", this.myResponder, this);
 ...
/* When a response comes back for report 197 then myOtherResponder is called */
 this.searchSource(197).on("response", this.myOtherResponder, this);

Additional Search Sources and Report Widgets  
You can include additional search sources in report events, allowing you to add to report results.

Search lter and report widgets have a source_id aribute. An example of a default value for the source_id aribute is
social for the CommunitySearchResults widget.

Seing source_id to this value means that the widget’s lter values are applied to searches for social. The KeywordText
and SearchBuon widgets are used to simultaneously search report 176 as well as social results.

<rn:widget path="search/KeywordText" report_id="176" source_id="social"/>
<rn:widget path="search/SearchButton" report_id="176" source_id="social"/>
<rn:widget path="reports/Multiline" report_id="176"/>

By extending from SearchFilter, widgets inherit the searchSource() method. The searchSource() method can be called
without any parameters. In this case, the caller gets back a handle to all reports and search sources that the widget has
declared in its report_id and source_id aributes. Subscribing to or ring on that handle happens for all of those reports
and search sources.

this.searchSource().on("search", sbl, this)

You can use the searchSource() function to respond to search events for additional sources. For example, for a widget
with the aributes report_id with the value 176 and the source_id aribute with the value social:

...
/* When a search is triggered for either report 176 or social then myHandlerFunction is called */
this.searchSource().on("search", this.myHandlerFunction, this);

...
/* When a search is triggered for the social source then myHandlerFunction is called */
this.searchSource(this.data.attrs.source_id).on("search", this.myHandlerFunction, this);

...
/* When a response comes back for report 176 then myResponder is called */
this.searchSource(176).on("response", this.myResponder, this);
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...
/* When a response comes back for social then myOtherResponder is called */
this.searchSource(“social").on("response", this.myOtherResponder, this);

In addition to the built-in external search source social, you can use any other search services that may be plugged-in.
You can set the source_id aribute to an arbitrary name or number, and widgets can specify what data is sent to the
server and where the data is to be sent.

The searchSource() method can also be called with a named subset of reports and search sources. In this case, the
caller gets back a handle to all named reports and search sources that the widget has declared in its report_id and
source_id aributes. Subscribing to or ring on that handle happens for only those named reports and search sources.
For example:

this.searchSource(176).on("search", sbl, this)
this.searchSource("social").on("search", sbl, this)

Finally, the searchSource() method can be called with a named subset and additionally specify these options.

• reportIDorNamedSearchSource—A report ID or source ID.

• endpoint—A string specifying where the AJAX request is handled.

• lters—An array specifying what report lter values are to be sent (only applies to non-report search sources).

• params—The key-value parameters to be sent to the server in the POST data.

For example, for a widget with source_id="sbl":

this.searchSource({
 /* name of the search source */
 "sbl": {
 "endpoint": "/cc/myCustomController/search",
 "filters": [ "keyword", "sort" ]
 "params": {
 "banana": 0
 }
}).on("search", function() {
 return new RightNow.Event.EventObject(this, {data: {
 resource: "123",
 numOfResults: 20
 }});
});

The AJAX request when a search is triggered for source_id="sbl" (where the user searched on iphone and sort is set to 2
is therefore:

POST /ci/myCustomController/search
FORM DATA keyword=iphone&sort=2&banana=0&resource=123&numOfResults=20

Overview of Creating Models  
You can create custom models that extend directly from the RightNow/Models/Base class. You can also create custom
models that extend from and override standard models, which themselves extend from Base.

Customizing models can be useful for modifying the behavior of all the widgets that make calls to a particular model.

In your custom models, you can include Connect PHP API calls as well as ROQL calls.

1333



Oracle Service Cloud
Using Service Cloud

Chapter 6
Customer Portal

You must create a custom model when you need to create access to data that is not available through the standard
models.

• Account—Retrieves details about agent accounts based on its ID value.

• Answer—Retrieves and manipulates knowledge base answers and also retrieves related and previous answers.

• AsyncBase—Makes asynchronous HTTP requests to external servers when you need to make several external
requests simultaneously without blocking execution.

• Base—Serves as the base class for all models and provides a number of boilerplate methods and a built in
cache.

• Chat—Initiates chat requests, sends content between the customer and agent, and checks on current chat
availability.

• Clickstream—Inserts entries into the clickstream table.

• Contact—Creates and updates contacts and retrieves contact data.

• Country—Returns a country from the Connect PHP API based on its ID value.

• Field—Marshals contact and incident form data and directs it to the correct model to create and update
records.

• FileAachment—Retrieves le aachments from sources such as answers, incidents, and guides.

• Guidedassistance—Returns a GuidedAssistance object from the database based on the ID value of the guide.

• Incident—Creates and updates incidents and retrieves incident data.

• Notication—Returns an array of specied product, category, and answer notications associated with the
interface and formats the answer summary.

• Polling—Retrieves questions for displaying polling data, submits poll questions, and retrieves poll results.

• PrimaryObjectBase—Serves as the base class for models that are used to retrieve, create, and update objects
within the Customer Portal.

• Prodcat—Retrieves product and category information from the database, works with product/category linking,
and gets partial hierarchies of the data.

• ProductCatalog—Retrieves product data from the database.

• Report—Retrieves and manipulates analytics reports.

• Social—Interacts with the Social API to create social posts and comments and memcaches the results for
performance benets.

• Survey—Accesses specied surveys.

• Topicbrowse—Retrieves topic browse trees.

Model Coding Standards  
There are coding standards for custom models.

Apply these standards when preparing custom models.

• File names—File names must be singular and in Pascalcase format.

• Class names—Class names should be the same as the le name.

• Content—All calls to access the database (Connect PHP API and ROQL calls) must be contained within a model
and not in any other part of the code.

• Data caching—If applicable, cache the results of database calls within the model. The two functions setCache()
and getCache() use keys to store data over the course of a request. Connecting to the database consumes more
resources and caching improves performance.
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Standard Models  
Standard models are contained within the RightNow/Models namespace, and are located in the /cp/core/framework/
Models folder.

Standard models include the Answer, Contact, and Incident models that provide access to objects in the knowledge
base. All standard models extend from the Base model class.

Overview of the ResponseObject Object  
Within a model, the easiest way to create a ResponseObject object is to use the getResponseObject() function, which is
dened in the Base model class.

For consistency, all functions in models should return a /RightNow/Libraries/ResponseObject object (all standard
models return this object). This is recommended because it enables the caller to determine how to handle any errors or
warnings, rather than requiring the called function to determine how to format and return the errors and warnings.

The only exception to returning the ResponseObject object is when a return type of the method is boolean. So, for
example, /RightNow/Models/Answer::exists() just returns true or false.

The ResponseObject object contains ve elds.

Field Name Type Description

result
 

mixed
 

Whatever the function returns.
 

errors
 

ResponseError array
 

error
 

ResponseError
 

First ResponseError in errors eld.
 

warnings
 

string array
 

Array of warning strings (for example, “Contact
is not logged in.” while retrieving an incident).
 

warning
 

string
 

First string in warnings eld.
 

This example, which makes a call to a standard model function to get notications for a contact, shows how a returned
ResponseObject is used.

 $notifications = $this->CI->model('Notification')->get('all', $contactID);
 if($notifications->error) {
 echo "Error about getting all notifications " . $notifications->error->externalMessage;
 /RightNow/Utils/Framework::logMessage("Warning about getting all notifications " . $notifications->error-
>externalMessage);
 return;
 }
 else if($notifications->warning) {
 // warnings are usually for developer consumption only
 /RightNow/Utils/Framework::logMessage("Warning about getting all notifications " . $notifications-
>warning);
 return;
 }
 // now get the actual list of notification objects
 $notifications = $notifications->result;
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 ...

This example throws an exception if a contact cannot be retrieved.

 if(!$contact = $this->CI->model('Contact')->get($contactID)->return)
 throw new /Exception("What happened here?");

The getResponseObject() function has four parameters, but only the $return parameter is required.

Parameter Type Description

$return
 

mixed
 

Whatever the function returns such as an
object, array, Boolean, or string.
 

$validationFunction
 

function
 

A callable function that takes the return value
as its only argument and returns true upon
success. If specied as null, no validation is
performed. The default value is is_object.
 

$errors
 

mixed
 

A ResponseError object, ResponseError array,
 error string, or error string array.
 

$warnings
 

mixed
 

A warning string or warning string array.
 

The ResponseError array contains ve elds.

Field Name Type Description

externalMessage
 

string
 

Error message to display to end users and
customers.
 

errorcode
 

string
 

An error code that can be used by the caller to
determine how to handle the error.
 

source
 

string
 

Denes where the error came from (for
example, models/standard/report).
 

internalMessage
 

string
 

Error message for internal use.
 

extraDetails
 

mixed
 

Any extra details to aach to the error (for
example, a stack trace).
 

The constructor of the ResponseError object has the same elds as shown in the above table and in the same order. The
only eld that is required is externalMessage.

This is an example of using the getResponseObject() function in a standard model.

 public function get($countryID)
 {
 if(!Framework::isValidID($countryID)){
 return $this->getResponseObject(null, null, "Invalid 
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Country ID: $countryID");
 }
 try{
 $response = Connect/Country::fetch($countryID);
 }
 catch(Connect/ConnectAPIErrorBase $e)
 {
 return $this->getResponseObject(null, null, $e-
>getMessage());
 }
 return $this->getResponseObject($response);

Extending from the Base Model  
You can create a custom model that extends directly from the Base model.

The custom model must extend from the Base model class and call the parent constructor within its constructor as
shown in this example.

 <?php
 namespace Custom/Models;
 class Sample extends /RightNow/Models/Base
 {
 function __construct()
 {
 parent::__construct();
 }
 function get($sampleID)
 {
 if(!/RightNow/Utils/Framework::isValidID($sampleID)){
 return $this->getResponseObject(null, null, "Invalid 
Sample ID: $sampleID");
 }
 return $this->getResponseObject(array('SampleID' => 
$sampleID, 'SampleName' => "Sample $sampleID"), 'is_array');
 }
 }

This example shows how you might use the custom model in a widget.

 $sampleObject = $this->CI->model('custom/Sample')->get($sampleID);
 if($sampleObject->error) {
 echo "Error in retrieving sample object " . $sampleObject->error-
>externalMessage;
 return;
 }
 echo "Sample Name: " . $sampleObject->result['SampleName'];

Extending from a Standard Model  
You can create a custom model that extends a standard model.

The custom model is then automatically used in place of calls to the parent standard model. All functions of the parent
model that are not marked as private can be called from the custom model.

The le extensions.yml le is a conguration le where you specify the standard models to override and the custom
model that extends each standard model. The le consists of modelExtensions entries that name the standard model to
override, and the custom model to use as a replacement.
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Note:  Use spaces and not tabs in the extensions.yml le.

To override the standard Answer model with a model at development/models/custom/ExtendedSample.php:

modelExtensions:
 Answer: ExtendedSample

To override the standard Contact model with a model at development/models/custom/contacts/
ContactCreation.php:

modelExtensions:
 Contact: contacts/ContactCreation

In the custom model, the class declaration must extend from the standard model as shown in this example, otherwise
an error is thrown at runtime.

class ExtendedSample extends /RightNow/Models/Contact

To call the function from a custom controller:

$this->model('Answer')->sampleFunction();

Extend a Standard Model  
You can extend a standard model.

1. Open /cp/customer/development/cong/extensions.yml.
2. Add this code to the page.

 modelExtensions:
 Answer: ExtendedSample

3. Make sure that the custom model le contains code similar to that used in this example, where the
ExtendedSample custom model extends from the Answer standard model.
 <?php
 namespace Custom\Models;
 require_once CPCORE . 'Models/Answer.php';
 
 class ExtendedSample extends \RightNow\Models\Answer
 {
 function __construct()
 {
 parent::__construct();

4. Add code to override functions from the parent model or add new functions.

Although this example shows how to extend the Answer model, you must pass in the name of the class you are
extending when you extend objects that Customer Portal modies (Contact, Incident, Asset, SocialQuestion,
SocialComment, and SocialUser).

To extend the SocialQuestion model, your code will look similar to this.
<?php
 namespace Custom\Models;
 require_once CPCORE . 'Models/SocialQuesion.php';
 class CustomSocialQuestion extends \RightNow\Models\SocialQuestion { 
 function __construct() { 
 parent::__construct('SocialQuestion'); 
 }
 }
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How You Call Model Functions  
The code to call a model function varies depending on where the model is called from.

To call the sampleFunction() function of the Sample model from a widget or another model:

 $this->CI->model('custom/Sample')->sampleFunction();

To call the function from a custom controller:

 $this->model('custom/Sample')->sampleFunction(); 

To call the function from anywhere else:

 $CI = get_instance();
 $CI->model('custom/Sample')->sampleFunction();

In each case, the model is automatically loaded.

When using the model() function to call a custom model’s functions, you must specify the path to the custom model, as
shown in this example:

 $sampleData = $this->CI->model('custom/input/SiteInfoCustomObject')-
>sampleFunction()->return;

However, in calls to standard models, you need to pass only the name of the model:

 $chatHours = $this->CI->model('Chat')->getChatHours()->return;

Creating Controllers  
You can create custom controllers that extend from the /RightNow/Controllers/Base class.

You cannot extend from any other controller class. All functions of the parent controller that are not marked as private
can be called from the custom controller and additional code can be added as required.

Functions in custom controllers are called by sending a request to a URL with this format.

cc/class_name/function_name

For example, to call the myHandler() function in the MyController.php controller, the URL is: /cc/myController/
myHandler

Controller Coding Standards  
Within controllers, group public functions that are callable from URLs at the top of the le.

All functions that are not intended to be callable with a URL should be labeled as private or protected, and their names
should begin with an underscore (_). This is the only location where you can start your function names with a non-
alphabetic character. Also, locate these private or protected functions toward the boom of the le. This organizes the
code beer and makes it obvious which functions can be called with a URL and which ones cannot. For example:

 function viewPage()
 ......
 private function _addParms()
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Only dene an index() function within your controller when you need to be able to call the controller without dening a
method. If you want to require a method to be dened to use the controller, omit the index() function.

Controller Function Content  
For controller functions that interact with models and are called by using AJAX requests, the content of the function
should harvest POST variables, call the model, and return JSON encoded data (plain text must not be returned from the
server).

Any business logic required for the AJAX call should be performed in the model. This allows model functions to be
easily reused. For example:

 function doSearch()

{ 
 $searchTerm = $this->input->post('term');
 $this->load->model('custom/Search');
 $results = $this->model('custom/Search')->query($searchTerm);
 echo json_encode($results);
 }

Adding Hooks  
Hooks are sections of code in custom models that allow you to extend Customer Portal functionality. You specify hooks
that you wish to execute before and after important events that occur within Customer Portal.

You can use hooks, for example, to modify data, perform custom validation, and return customized error messages to
display to the user.

You dene hooks in /cp/customer/development/cong/hooks.php with $rnhooks. You specify the hook location that
is, the event associated with the hook, as the array index and set that index to an array of three items.

• class—The name of the custom model you wish to use. The class name must match the name of the custom
model, including case sensitivity.

• function—The name of the function within the class to call.

• lepath—The location of the model, which is automatically prexed with models/custom/. The lepath item
needs a value only if your model is contained within a subfolder.

For example, assume you want to call the sendFeedback() function immediately after an incident is created,
and you will use the Immediateincidentfeedback model, which you created and placed in models/custom/
Immediateincidentfeedback.php.

$rnHooks['post_incident_create'] = array(
 'class' => 'Immediateincidentfeedback',
 'function' => 'sendFeedback',
 'filepath' => ''
 );

For a list of events and more examples of hooks, review the comments in the hooks.php le.
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Creating Custom Libraries  
You can add custom libraries containing sets of utility functions.

A custom library must be a class le and located in the folder /cp/customer/development/libraries. This example
shows the structure for a Sample.php library.

namespace Custom/Libraries;
class Sample
{
 function __construct()
 {
 }
 function sampleFunction()
 {
 }
}

Loading a Library  
You can load a library in dierent ways depending on where it’s being called.

To load a library called Sample from a widget or model:

 $this->CI->load->library('Sample');

To load the library from a custom controller:

 $this->load->library('Sample');

To load the library from anywhere else, including other libraries:

 $CI = get_instance();
 $CI->load->library('Sample');

Calling a Library Function  
After a library loads, you can call a library function in dierent ways, depending on where it’s being called.

To call the sampleFunction() function in the Sample library from a widget or model:

 $this->CI->sample->sampleFunction();

To call the function from a custom controller:

 $this->sample->sampleFunction();

To call the function from anywhere else, including other libraries:

 $CI = get_instance();
 $CI->sample->sampleFunction();
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Creating Helpers  
You can add custom helpers in the folder /cp/customer/development/helpers.

You can load a helper in dierent ways depending on where it’s being called. For example, to load a sample_helper.php
le containing a helper function from a widget or model:

$this->CI->load->helper('sample')

From a custom controller:

$this->load->helper('sample')

To load multiple helpers at the same time, you can pass an array that loads each helper le, using the format shown in
this example.

$this->load->helper(array ('sample1','sample2','sample3'))

After a helper is loaded you can call all functions in the helper by simply using the name of the function, for example,
helperFunction().

Loading JavaScript Content on Every Page  
The autoload JavaScript le is automatically loaded on every page so you can put common functions and event
declarations in a single location.

You could add code like this to the /cp/customer/development/javascript/autoload.js le to override the default
failure handler and not display the error dialog if a particular request fails.

RightNow.Event.subscribe("on_before_ajax_request", function(name, data){
 data = data[0];
 if(data.url === '/ci/ajaxRequestMin/getHierValues'){
 data.failureHandler = function(response){};
 }
});

This code subscribes to an event that is red before making an AJAX request. In this case, if the request is made to a
specic URL, the failure handler function is set to not do anything, and the request can be modied as required.

Customizing Error Pages  
Besides customizing the appearance of error pages, you can also display severity, message, le name, and line number
where the error occurred if an error occurs.

The /cp/customer/development/errors folder contains two PHP scripts used to display customized error pages.
These are error_general.php and error_php.php. By customizing these pages, you can provide your customers with
more specic information than they will receive from a standard 404 error page delivered by the web server. You can
edit these les but you cannot add any les to this folder.
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Additionally, the /cp/customer/error folder contains these static HTML pages that you can customize to provide
additional information when these error types are returned. The default message is “There has been an error with your
request.”

• error404.html—Displayed when an HTTP 404 Not found error code is returned.

• error413.html—Displayed when an HTTP 413 Request entity too large error code is returned.

• error500.html—Displayed when an HTTP 500 Internal server error code is returned.

The splash.html page is displayed when your site is being upgraded.

Dynamic Forms  
A dynamic form is a form with elds that change depending on selections in other elds. These are the general steps for
creating a dynamic form.

The Customer Portal includes a change handler for the Field.js module (used by input widgets) in the Customer Portal
JavaScript API. Input widgets subscribe to this change handler, which is called anytime the widget changes. When you
want a widget for a dynamic form, you extend the corresponding standard input and override the onChange function.
All input widgets have a hide_on_load aribute to let you hide forms that should appear only when the input value
of another widget matches the condition you dene. The change handler is triggered by changes to any form eld.
In addition to changing a eld’s visibility, you can also change whether it is required based on a previous eld. The
setConstraints method indicates whether customers must add a value to the eld.

1. Create a new widget by extending one of the following standard input widgets (DateInput,
FileAachmentUpload, MobileProductCategoryInput, PasswordInput, ProductCategoryInput, SelectionInput, or
TextInput).

Note:  This is the widget that triggers the change when its value is changed rather than the widget
that changes as a result of a value change. For example, if you want to make the Incident.Product eld
required when the Incident.Subject eld equals “test,” extend the TextInput widget so you can use it
with the Incident.Subject eld.

2. Edit the widget you created so it subscribes to the change event handler.
3. Use the ndField method to retrieve the eld that should change (the Incident.Product eld in this example).
4. Call the setContraints method with a JavaScript object (for example, constraint = {required:true}) to change

the eld.

Use the Dynamic Forms Sample Code  
The following procedure describes the necessary steps for using the dynamic forms sample code.

1. Download DynamicForm.zip from hp://documentation.custhelp.com/euf/assets/devdocs/unversioned/
cp_resources/samples/DynamicForm.zip and extract the les.

2. Copy the downloaded dynamic_ask.php le from the Dynamic Form/customer/development/views/pages
folder and paste into your development pages at /cp/customer/development/views/pages.

3. Copy the downloaded input folder from Dynamic Form/customer/development/widgets/custom and paste
into your development pages at /cp/customer/development/widgets/custom.

4. Activate the downloaded widget.
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a. Go to the Customer Portal Administration site at hps://[your_site]/ci/admin/versions/manage.
b. Locate the DynamicProductCategoryInput widget.
c. Select the widget and click Activate this Version.

5. Create a new custom object.
a. Log in to Oracle Service Cloud.
b. Double-click Object Designer.
c. Click Import, browse to Dynamic Form/exports/CP CustomObject.zip, and click Open.
d. Click Next, and then click Next again.
e. Click Save.
f. Click Deploy.

6. On the Service Console, click Service and then double-click Products/Categories/Dispositions.
7. Hover over the products and categories for the ID values of the products and categories you want to use in the

sample code.
You will replace the product and category ID values used in the sample code with IDs that are relevant to your
customer portal.

8. Edit the dynamic_ask.php page to use your organization’s product and category IDs.
These IDs are referenced in lines 33, 43, and 44.
When you go to your development site and select various products and categories, you will notice that the
displayed elds vary with your selections. Notice that the sample code in the dynamic_ask.php page rst
displays the Category eld only for selected products (those products associated with ID 1 and ID 2 in the
sample code). Then it displays selected elds based on the category ID.For example, using the code sample,
select product ID 2 and category ID 68 will display the custom Serial Number eld. The following table shows
the dynamic elds that are displayed and/or required for selected product and category IDs called out in the
code sample. You can substitute your product and category IDs to create a similar matrix for testing your
custom code.

Product ID Category ID Displayed/Required Dynamic
Fields

1 or 2
 

68
 

Serial Number
 

1 or 2
 

78
 

Serial Number
 
Purchase Date
 
Request Callback
 

1 or 2
 

All
 

Email Address
 
Subject
 
Question
 
Aach Documents
 

1 or 2
 

77
 

Required: Aach Documents
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Product ID Category ID Displayed/Required Dynamic
Fields

1 or 2
 

78
 

Required: Serial Number
 
Required: Aach Documents
 

1 or 2
 

79
 

Required: Aach Documents
 

Install the AdditionalResults Widget  
The AdditionalResults sample widget queries a third-party search API when searching the Oracle Service Cloud
knowledge base and appends the results onto the end of report results. It extends from the standard Multiline widget.

Duck Duck Go is the third-party search engine used as the source for search results. Simple phrases and keywords will
return results, but Duck Duck Go’s search API does not return results for complex queries or questions.

This sample widget assumes that the default Multiline report (ID 176) is being used.

1. Create a search folder in /cp/customer/development/widgets/custom.
2. Download Additional Results.zip from hp://documentation.custhelp.com/euf/assets/devdocs/unversioned/

cp_resources/samples/AdditionalResults.zip and extract the les.
3. Move or copy the AdditionalResults.css le from the unzipped Additional Results/customer/assets/

themes/standard/widgetCss folder into your /cp/customer/assets/themes/standard/widgetCss folder.
4. Move or copy the unzipped Additional Results/customer/development/widgets/custom/search/

AdditionalResults folder into your /cp/customer/development/widgets/custom/search folder that you
created in step 1.

5. Activate the AdditionalResults widget.
a. Go to hps://<your_site>/ci/admin/versions/manage.
b. Locate and select the AdditionalResults widget.
c. Click Start Using This Version.

6. Place the widget on a Search Results page and add the source_id aribute to widgets that are to trigger and
provide lter values for the search.

How to Use Sample Code  
You must complete the following tasks before you can use the sample code.

1. Create a menu-only custom object, TypeOfFeedbackMenu, with seings as follows:

◦ Type—Menu Only Object

◦ Package—CO

◦ Menu Items—Complaint, Compliment, Suggestion, Question/Concern.
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2. Add a custom eld, type, for Incident, with seings as follows:

◦ Name—type

◦ Label—Type of feedback

◦ Package—CO

◦ Data Type— Menu

◦ Menu—CO.TypeOfFeedback.

3. Add a custom eld, source, for Incident, with seings as follows:

◦ Name—source

◦ Package—CO

◦ Label—How did you nd this answer?

◦ Field Usage—Long text.

Install the ExtendedAnswerFeedback Widget  
The ExtendedAnswerFeedback sample widget extends the standard AnswerFeedback widget to display and submit
custom Incident elds in the feedback form.

This sample is one of the possible solutions to this common customization scenario. A dierent implementation could,
for example, send the AJAX request to a custom endpoint that then sends the POST parameters to a custom model that
either extends the standard Incident model or re-implements its own feedback creation logic. That implementation is a
more classical approach to the problem, but it involves more code.

The approach that this sample takes—allowing the standard controller endpoint and model to process the feedback
submial normally, but using a hook model to add POST parameter values to the incident—is probably not the cleanest
approach. However, it has the advantage of leaving the standard controller and Incident model processing intact, so
that features like auto abuse-detection and enhancements and bug xes in future framework updates will continue to
happen automatically.

The sample widget requires two Incident custom elds. As the two incident custom elds are editable by the user,
they will appear anywhere that the standard CustomAllInput widget is used. When the elds are not null, they will also
appear where the standard CustomAllDisplay widget is used, for example, on the questions/detail page.

1. Create a feedback folder in /cp/customer/development/widgets/custom.
2. Download ExtendedAnswerFeedback.zip from hp://documentation.custhelp.com/euf/assets/devdocs/

unversioned/cp_resources/samples/ExtendedAnswerFeedback.zip and extract the les.
3. Move or copy the ExtendedAnswerFeedback.css le from the unzipped Extended AnswerFeedback/

customer/assets/themes/standard/widgetCss folder into your /cp/customer/assets/themes/standard/
widgetCss customer portal le folder.

4. Move or copy the unzipped Extended AnswerFeedback/customer/development/widgets/custom/
feedback/ExtendedAnswerFeedback folder into your /cp/customer/development/widgets/custom/
feedback folder that you created in step 1.

5. Activate the ExtendedAnswerFeedback widget.
a. Go to hps://<your_site>/ci/admin/versions/manage.
b. Locate and select the ExtendedAnswerFeedback widget.
c. Click Start Using This Version.
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6. Replace the AnswerFeedback widget on the standard answers/detail.php page with
ExtendedAnswerFeedback.

7. Move or copy the CustomIncidentModel.php le from the unzipped Extended AnswerFeedback/customer/
development/models/custom folder into your /cp/customer/development/models/custom folder.

8. Register the hook by adding this code to /cp/customer/development/cong/hooks.php.
 $rnHooks['pre_feedback_submit'] = array(
 'class' => 'CustomIncidentModel',
 'function' => 'preFeedbackSubmit',
 );

9. To view the new custom eld values on newly-created Answer feedback incidents, add the new Incident.Co.type
and Incident.CO.source elds to the Incident workspace that’s currently in use.

Install the DisplayChartReport Widget  
The DisplayChartReport sample widget is an example of how to use the YUI charting library, a custom widget AJAX
endpoint, and a custom report to create a chart display widget for two-dimensional data.

The widget retrieves the data from a report and sends it to the client side to be displayed. When the data arrives at the
client side, it is extracted from the data array and transformed into the appropriate format for the YUI charting library.
This transformed data can be used to render any two-dimensional YUI chart including bar, column, line, and pie charts.
These charts are displayed using Scalable Vector Graphics (SVG) to create a simple interactive chart.

The widget also contains a buon to update the displayed results. The buon makes an AJAX request to the server to
get the modied results (in this case, simple random data), which is then displayed to the user. The widget expects the
rst two columns of the report data to be the rst two dimensions of the rendered chart. If you plan to use the widget as
more than a sample, it is worth modifying the controller to more intelligently handle dierent formats of report data.

1. Create a samples folder in /cp/customer/development/widgets/custom.
2. Download DisplayChartReport.zip from hp://documentation.custhelp.com/euf/assets/devdocs/

unversioned/cp_resources/samples/DisplayChartReport.zip and extract the les.
3. Move or copy the DisplayChartReport.css le from the unzipped DisplayChartReport/customer/assets/

themes/standard/widgetCss folder into your /cp/customer/assets/themes/standard/widgetCss
customer portal le folder.

4. Move or copy the unzipped DisplayChartReport/customer/development/widgets/custom/sample/
DisplayChartReport folder into your /cp/customer/development/widgets/custom/sample folder that you
created in step 1.

5. Import the DisplayChartReport/exports/report_def.xml le into the Reports Explorer and note the report ID.
6. In the info.yml le, change the default value for the report_id aribute from -1 to the report ID from step 5.
7. Activate the DisplayChartReport widget.

a. Go to hps://<your_site>/ci/admin/versions/manage.
b. Locate and select the DisplayChartReport widget.
c. Click Start Using This Version.

8. Place the widget on a page.
<rn:widget path="sample/DisplayChartReport"/>
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Install the PollingSlider Widget  
The custom PollingSlider widget extends the standard Polling widget to create a slider drawer at the boom of the page
that opens a polling survey when it is clicked.

• Create a choice question for the survey you want to add to the page.

• Create a polling survey.

• Determine the survey ID value.

1. Create a surveys folder in /cp/customer/development/widgets/custom.
2. Download Polling Slider.zip from hp://documentation.custhelp.com/euf/assets/devdocs/unversioned/

cp_resources/samples/PollingSlider.zip and extract the les to a temporary location.
3. Move or copy the PollingSlider.css le from the unzipped Polling Slider/customer/assets/themes/

standard/widgetCss folder into your /cp/customer/assets/themes/standard/widgetCss customer portal
le folder.

4. Move or copy the unzipped Polling Slider/customer/development/widgets/custom/surveys/PollingSlider
folder into your /cp/customer/development/widgets/custom/surveys folder that you created in step 1.

5. Activate the PollingSlider widget.
a. Go to hps://<your_site>/ci/admin/versions/manage.
b. Locate and select the PollingSlider widget.
c. Click Start Using This Version.

6. Open the page where you want to add the widget and add this code, substituting the survey ID for “12” in this
example:
 <rn:widget path="surveys/PollingSlider" survey_id="12" />

Note:  It doesn’t maer where you add the code because the widget CSS places it at the boom of the
page automatically. If you want to test the survey on your development page, add cookie_duration="0"
to the widget code. This prevents a cookie from being set so you can take the survey repeatedly. (Your
customers will not be oered a survey again. Instead, they will simply see the results of the survey until
the cookie on their browser expires.)

Extending the Standard Answer Model to a Custom Model  
This sample custom model extends from the standard Answer model.

This model provides am emailToFriend() function that overrides the parent function so that the From eld is modied
with a company email address.

 <?php
 namespace Custom/Models;
 class ExtendedSample extends /RightNow/Models/Answer
 {
 function __construct()
 {
 parent::__construct();
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 }
 function emailToFriend($sendTo, $name, $from, $answerID){
 // Modify from field to company email and add user specified 
 // email to name
 $name .= "(Email: $from)";
 $from = "support@companyName.com";
 $response = parent::emailToFriend($sendTo, $name, $from, 
$answerID);
 // Remember that $response is an instance of a 
 // ResponseObject, so we need to check the return property 
 // for success
 if($response->result){
 return $response;
 }
 // Add an additional error to the return which might be 
 // potentially handled by a custom widget
 $response->error = "Unable to send email, please try again 
later.";
 return $response;
 }
 }

Custom Controller Required Structure  
This sample code illustrates the required structure of a custom controller.

 <?php
 namespace Custom/Controllers;
 class AjaxCustom extends /RightNow/Controllers/Base
 {
 // This is the constructor for the custom controller. 
 // Do not modify anything within this function.
 function __construct()
 {
 parent::__construct();
 }
 /**
 * Sample function for ajaxCustom controller. This function 
 * can be called by sending a request to: 
 * /ci/ajaxCustom/ajaxFunctionHandler.
 */
 function ajaxFunctionHandler()
 {
 $postData = $this->input->post('post_data_name');
 //Perform logic on post data here
 echo $returnedInformation;
 }
 }

Customer Portal Framework  
The Customer Portal is a web application framework based on the Model-View-Controller (MVC) design paern.
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Folder Description

Pages The les containing the HTML code for the customer portal.

Templates The wrapper of HTML and CSS around the pages and widgets.

Assets CSS les, images, and themes.

Models PHP classes that include functions to access the knowledge base.

Controller PHP classes that handle requests from the client and coordinate access to the knowledge base and the
display of data to the user.

Widgets Collections of les containing HTML, CSS, JavaScript, and PHP code that provides specic
functionality. The page les contain the code to call widgets.

Hooks Custom code to extend Customer Portal functionality. You specify hooks that execute before and after
important Customer Portal events.

Helpers PHP les containing utility functions.

Libraries PHP classes containing a set of utility functions.

Folder Path Description Visible to customers

Development les /cp/customer The les you work with when
you want to make changes to the
customer portal.

No

Staging les /cp/generated/staging The les compiled and optimized
to look and perform as they will on
the production site. They are not
editable.

No

Production les /cp/generated/
production

The les you have promoted from
the staging site.

Yes

Reference implementation les /cp/core/framework/
views

The default, read-only les that
make up the original Customer
Portal reference implementation
before you make any changes.

• reference assets—/cp/
core/widgets

• standard widgets—/cp/
core/assets

No

Tools for Working with the Customer Portal Framework  
There are software and tools available to assist you with Customer Portal framework.
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Tool Description

Code assistant You can use this tool to simplify the migration process between framework versions and provides
specic guidance for updating your custom code.

Code editor You can use any software development application, for example, Eclipse, Vim, or Adobe Dreamweaver,
 to develop your custom code.

Customer Portal Web Administration site • View the development, staging, and production areas.

• View information about framework versions.

• Review widget information and access the widget builder.

• Review page tag and business object documentation.

• Stage and promote your development pages.

• Access further documentation, resources, and developer community pages.

• View log les.

Version control system You can use any version control system, for example, Apache Subversion (SVN), Git, or Mercurial, to
provide revision control for your custom code.

WebDAV client You need a client that supports WebDAV, the standard protocol for managing and updating les on a
web server. A WebDAV client allows you to map the cp/ directory to a local drive leer.

Widget builder You can use this tool, which is available from the Customer Portal Web Administration site, for
developing custom widgets rapidly. You can create a completely new widget or extend the functionality
of an existing widget.

Mobile Customer Portal  

Overview of Mobile Customer Portal  
The Oracle RightNow Customer Portal Cloud Service (Customer Portal) not only provides a superior customer
experience on full-featured browsers, but also includes a reference implementation designed specically for mobile
devices.

In addition to its streamlined interface and optimized performance, the mobile customer portal includes the ability to
direct customers to a predened page set based on the type of device they use to access your support site.

Using the default mobile reference implementation, customers can view popular answers and featured support
categories. They can conduct searches, view lists of answers and individual answers, and provide feedback on an
answer. They can also submit questions, update their account information, chat with an agent, and be guided through a
series of questions to reach a solution.

The mobile reference implementation was tested on devices using these operating systems.

• Android 1.5+

• iPhone 3.1+

Although not ocially supported, other devices that support full-featured browsers (those supporting JavaScript, style
sheets, and cookies) are expected to be able to use the mobile reference implementation without customization.
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The mobile customer portal pages are automatically included in the Customer Portal reference implementation.
This section describes the steps you must take so you can view the mobile pages in development mode and so your
customers with mobile devices can view them on your production site.

Step 1—Enable page set mappings. This step is critical for viewing the mobile customer portal.

Step 2—Decide where you want to view the development pages. Your options include viewing them on your regular
desktop workstation, mobile devices, and mobile device emulators.

Step 3—Edit the mobile reference implementation to incorporate all the changes you eventually want to include on your
production site.

Step 4—Dene the user agent mapping so customers who use desktop browsers can view your standard pages and
those using mobile devices can view your mobile pages.

Step 5—Stage and promote the customer portal so the mobile development pages you have been working on are
promoted to your production site.

Enable Page Set Mappings  
After you enable one or more page set mappings on any system and then set the development area for the specic
browser or device, you can view the default mobile page set in the development area.

Before you can view the mobile customer portal page set in the development area, you must enable at least one of the
default page set mappings.

1. In a web browser, enter https://<your_site>/ci/admin.
2. Click Page Set Mappings.
3. Click Enable in the right column for one or more of the three mobile devices (iPhone, Android, and Palm).
4. To make these pages available on your production site, log in to Oracle Service Cloud and stage and promote

your pages.

Mobile Development Pages  
When you begin working on your development pages, you’ll want to test and review your changes before you stage and
promote them into production.

You can—and should—review the pages on the actual mobile devices you expect your customers to use to access your
support site before you promote the changes. However, you might prefer to do preliminary testing on your desktop
browser or a mobile device emulator.

Although you need to enable the page set mappings just once on any browser or device you choose, you must set the
development area for each browser or device you test on. For example, assume you want to test your mobile pages on
your iPhone and also on an Android emulator. You must select the development area separately for each device. And if
you want to also view your mobile pages on your workstation without an emulator, you must set the development area
for your browser too.

You can view the mobile development pages:

• On a mobile device.

• On a mobile device emulator.

• On your workstation using one or more browsers.
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Note:  You may nd it easier to verify pages on your desktop browser instead of a mobile device emulator
because emulators typically have slower performance. (Google Chrome provides the most representative
mobile page set when viewed in a web browser.) Still, before you stage and promote your development pages,
you should always preview your pages on the actual kinds of mobile devices you expect your customers to
use.

View Development Pages on a Mobile Device or Emulator  
You can preview your development pages using a mobile device or mobile device emulator.

You must complete the procedure in Enable Page Set Mappings before you set the development area.
1. On your mobile device or emulator, open hps://<your_site>/ci/admin.

Note:  For the best mobile customer portal experience, devices should be congured to load images
on web pages. If images are turned o, display issues may occur.

2. On the Quick Shortcuts Dashboard, click View Development Area.

View Mobile Development Pages on a Desktop Workstation  
You can preview your development pages on a desktop workstation.

You must complete the procedure in Enable Page Set Mappings before you set the development area.

1. On your workstation browser, open hps://<your_site>/ci/admin.
2. On the Quick Shortcuts Dashboard, click Set Environment.
3. In the Production drop-down menu, select Development.

Note:  If you want to view your current production site, you can select Production. However, if you
haven’t staged and promoted the customer portal after enabling the page set mappings, the mobile
pages will not be displayed on your production site.

4. Clear the check box that says “Allow my current browser/user agent to be the deciding factor.”
5. In the drop-down menu just above the check box, select Mobile.

Note:  If the Mobile option doesn’t appear in the menu, at least one default page set mapping must
rst be enabled.

6. Click Set Viewing Mode and View the Site.

Dene User Agent Mapping  
You want your customers to be automatically directed to the correct interface based on the browser they are using. User
agent mapping lets you control how that occurs. It also lets you dene unique page sets for various mobile devices if
you want.

1. Access the Customer Portal Administration site.
2. On the Quick Shortcuts Dashboard, click Set Environment.
3. Select Allow my current browser/user agent to be the deciding factor.
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4. Click Set Viewing Mode and View the Site.

Mobile Template Conguration  
The mobile reference implementation for the Customer Portal includes its own template and a set of pages specic to
the mobile customer portal. The template and pages are optimized for mobile devices, and many of the widgets are
specially designed for the mobile application.

The le for the mobile reference implementation template is located in the customer portal le structure in /cp/
customer/development/views/templates/mobile.php. The template includes a Menu buon, a Search eld and
buon, and a page set selector that lets customers display the standard page set on their mobile device if they choose.
It also includes a Log In or Sign Up buon, an option that takes customers to the top of the page, and another link for
the Oracle Service Cloud website.

Congure the Menu  
The Menu buon expands and collapses the Support Home and Contact Us options. You can edit the buon label and
remove or add navigation options.

1. Open /views/templates/mobile.php.
2. To change the “MENU” heading, follow these steps.

a. Locate <label class="rn_NavigationMenuButton"
for="rn_NavigationMenuButtonToggle">#rn:msg:MENU_LBL#</label>.

b. Change #rn:msg:MENU_LBL# to your new label.
c. To remove the Support Home option, delete <li><rn:widget path="navigation/NavigationTab"

label_tab="#rn:msg:SUPPORT_HOME_TAB_HDG#" link="/app/#rn:config:CP_HOME_URL#" pages="home"/></li>.
d. To remove the Contact Us option, delete these lines of code.

<rn:condition config_check="MOD_CHAT_ENABLED == false">
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
<rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CHAT_LBL# > /app/chat/chat_launch, #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/
></li>
</rn:condition>

3. To add options to the Menu buon that will take your customers to pages in your customer portal or to external
URLs:

a. Delete the default code for the Support Home and Contact Us options you located in step 2.
b. Locate <ul class="rn_NavigationMenu">.
c. Modify the code to add navigation options.

<ul class="rn_NavigationMenu">
 <li><a href="/app/#rn:config:CP_HOME_URL##rn:session#">Go to Home page</a></li>
 <li><a href="/app/ask#rn:session#">Ask a question</a></li>
 <li><a href="/app/answers/list#rn:session#">View all answers</a></li>
 <li><a href="/app/account/change_password#rn:session#">Change your password</a></li>
 <li><a href="http://www.oracle.com">Oracle</a></li>

4. Save the le.
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Congure the Contact Us Menu  
You can congure the Contact Us menu.

1. Open /views/templates/mobile.php.
2. To remove the Chat option, delete this code.

 <rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" 
label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/ask" 
subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, 
#rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask, 
#rn:msg:CHAT_LBL# > /app/chat/chat_launch, 
#rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>

3. To remove other options from the Contact Us menu, locate this code.
 <rn:condition config_check="MOD_CHAT_ENABLED == false">
 <li><rn:widget path="navigation/NavigationTab" 
 label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/ask" 
 subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, 
 #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask, 
 #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
 <rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" 
 label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/ask" 
 subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, 
 #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask, 
 #rn:msg:CHAT_LBL# > /app/chat/chat_launch, 
 #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
 </rn:condition>

◦ To remove the Email Us option, delete #rn:msg:EMAIL_US_LBL# > /app/ask, from the code for both
NavigationTab widgets.

◦ To remove the Ask the Community option, delete #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
from the code for both NavigationTab widgets.

◦ To remove the Call Us Directly option, delete , #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0)
from the code for both NavigationTab widgets.

4. To add options to Contact Us, add code in the location where you want it to appear in the list of options, making
sure it precedes the closing "/><li> tags.
This example adds a link for driving directions after the Call Us Directly option. To ensure the option appears in
the menu when chat is enabled, as well as when it is disabled, add the code in the widget for each condition.
, Get driving directions > http://www.mapquest.com/
maps?city=Bozeman&state=MT&address=136+Enterprise+Blvd&zipcode=59
718-5945&country=US&latitude=45.655298&longitude=-
111.06968&geocode=ADDRESS

5. Save the le.

Add a URL for the Call Us Directly Option  
You can specify a URL to take your customers to a web page containing your organization’s contact information.

1. Open /views/templates/mobile.php.
2. Locate this code.

<rn:condition config_check="MOD_CHAT_ENABLED == false">
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 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
<rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CHAT_LBL# > /app/chat/chat_launch, #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
</rn:condition>

3. Replace both instances of javascript:void(0); with the URL for your Contact page.
Your edited code will resemble this.
<rn:condition config_check="MOD_CHAT_ENABLED == false">
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CALL_US_DIRECTLY_LBL# > http://www.oracle.com/company-contact.php "/></li>
<rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CHAT_LBL# > /app/chat/chat_launch, #rn:msg:CALL_US_DIRECTLY_LBL# > http://www.oracle.com/
company-contact.php "/></li>
</rn:condition>

4. Save the le.

PageSetSelector Widget  
If you select the “Allow my current browser/user agent to be the deciding factor” check box on the Set Environment
page of the Customer Portal Administration site, the page set is determined by the user agent accessing the pages.

As a result, the mobile page set opens when mobile devices access the customer portal. The PageSetSelector widget
lets customers select whether they view the standard reference implementation or the basic page set on their mobile
device, instead of viewing the mobile page set.

Note:  Cookies must be enabled on the customer’s browser to allow this option. If cookies are disabled and the
Desktop or Basic option is selected, the mobile page simply refreshes.

Add a Phone Number to the Contact Us Options  
You can add a contact phone number to the options in Contact Us.

1. Open /views/templates/mobile.php.
2. Locate this code.

<rn:condition config_check="MOD_CHAT_ENABLED == false">
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
<rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CHAT_LBL# > /app/chat/chat_launch, #rn:msg:CALL_US_DIRECTLY_LBL# > javascript:void(0); "/></li>
</rn:condition>

3. Edit the code to replace the Call us directly message base with your phone number. Your edited code will
resemble this.
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<rn:condition config_check="MOD_CHAT_ENABLED == false">
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/ask"
 subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask, Call us
 at (999) 555-1212 > javascript:void(0); "/></li>
<rn:condition_else/>
 <li><rn:widget path="navigation/NavigationTab" label_tab="#rn:msg:CONTACT_US_LBL#" link="/app/
ask" subpages="#rn:msg:EMAIL_US_LBL# > /app/ask, #rn:msg:ASK_THE_COMMUNITY_LBL# > /app/social/ask,
 #rn:msg:CHAT_LBL# > /app/chat/chat_launch, Call us at (999) 555-1212 > javascript:void(0); "/></li>
</rn:condition>

4. Save the le.

Add an Option to the Account Menu  
You can add options to the Account menu.

1. Open /views/templates/mobile.php.
2. Locate this code.

<rn:condition_else/>
 <rn:condition is_active_social_user="true">
 <rn:widget path="login/AccountDropdown"
 label_menu_accessibility="#rn:msg:DOUBLE_TAP_TO_OPEN_OR_CLOSE_THE_MENU_LBL#"
 subpages="#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL#
 > account/profile, #rn:msg:PUBLIC_PROFILE_LBL# > #rn:config:CP_PUBLIC_PROFILE_URL#/user/
#rn:profile:socialUserID#"/>
 <rn:condition_else/>
 <rn:widget path="login/AccountDropdown"
 label_menu_accessibility="#rn:msg:DOUBLE_TAP_TO_OPEN_OR_CLOSE_THE_MENU_LBL#"
 subpages="#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL# >
 account/profile"/>
 </rn:condition>

3. Add a name and page location (for example: Change your password > account/change_password#rn:session#,) to
the code where you want the option to appear in the list of options.

a. Choose where you place the option code based on who you want to see the option.

◦ If you want the option to be available to everyone, place it in the Account Dropdown widget block of code
in the <rn:condition_else/> condition tag.

◦ If you want the option to be available to community users, place it in the AccountDropdown widget in the
<rn:condition is_active_social_user=”true”> condition tag.

◦ If you want the option to be available when customers are logged in, place the new option in the
AccountDropdown widget for both conditions.

Because our example is adding a change password option, we’ll put it between the options available to logged-
in customers: Support History and Account Seings.

<rn:condition is_active_social_user="true">
 <rn:widget path="login/AccountDropdown"
 label_menu_accessibility="#rn:msg:DOUBLE_TAP_TO_OPEN_OR_CLOSE_THE_MENU_LBL#"
 subpages="#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, Change your password
 > account/change_password#rn:session#, #rn:msg:ACCOUNT_SETTINGS_LBL# > account/profile,
 #rn:msg:PUBLIC_PROFILE_LBL# > #rn:config:CP_PUBLIC_PROFILE_URL#/user/#rn:profile:socialUserID#"/>
<rn:condition_else/>
 <rn:widget path="login/AccountDropdown"
 label_menu_accessibility="#rn:msg:DOUBLE_TAP_TO_OPEN_OR_CLOSE_THE_MENU_LBL#"
 subpages="#rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list, Change your password > account/
change_password#rn:session#, #rn:msg:ACCOUNT_SETTINGS_LBL# > account/profile"/>
</rn:condition>
</rn:condition>
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4. Save the le.

Remove Default Options from the Account Menu  
You can remove options from the Account menu.

1. Open /views/templates/mobile.php.
2. To remove the Sign Up and Log In options, delete the following lines of code.

 <div class="rn_LoginStatus">
 <rn:condition logged_in="false">
 <rn:widget path="login/AccountDropdown" 
subpages="#rn:msg:ACCOUNT_OVERVIEW_LBL# > account/overview"
 sub:input_Contact.Emails.PRIMARY.Address:label_input="#rn:msg
:EMAIL_ADDR_LBL#"
 sub:input_Contact.Emails.PRIMARY.Address:required="true"
 sub:input_Contact.Emails.PRIMARY.Address:validate_on_blur="tr
ue"
 sub:input_Contact.Login:label_input="#rn:msg:USERNAME_LBL#"
 sub:input_Contact.Login:required="true"
 sub:input_Contact.Login:validate_on_blur="true"
 sub:input_Contact.Name.First:required="true"
 sub:input_Contact.Name.First:label_input="#rn:msg:FIRST_NAME_
LBL#"
 sub:input_Contact.Name.Last:required="true"
 sub:input_Contact.Name.Last:label_input="#rn:msg:LAST_NAME_LB
L#"
 sub:input_SocialUser.DisplayName:label_input="#rn:msg:DISPLAY
_NAME_LBL#"
 sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_L
BL#"
 />
 <rn:condition_else/>
 <rn:condition is_active_social_user="true">
 <rn:widget path="login/AccountDropdown" 
label_menu_accessibility="#rn:msg:DOUBLE_TAP_TO_OPEN_OR_C
LOSE_THE_MENU_LBL#" 
subpages="#rn:msg:SUPPORT_HISTORY_LBL# > account/
questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL# > account/
profile, #rn:msg:PUBLIC_PROFILE_LBL# > 
#rn:config:CP_PUBLIC_PROFILE_URL#/user/
#rn:profile:socialUserID#"/>
 <rn:condition_else/>
 <rn:widget path="login/AccountDropdown" 
label_menu_accessibility="#rn:msg:DOUBLE_TAP_TO_OPEN_OR_C
LOSE_THE_MENU_LBL#" 
subpages="#rn:msg:SUPPORT_HISTORY_LBL# > account/
questions/list, #rn:msg:ACCOUNT_SETTINGS_LBL# > account/
profile"/>
 </rn:condition>
 </rn:condition>
 </div>

3. To remove the Support History option, delete the following line of code from both AccountDropdown widgets in
the rst rn:condition_else.
 #rn:msg:SUPPORT_HISTORY_LBL# > account/questions/list,

4. To remove the Account Seings option, delete the following line of code from both AccountDropdown widgets
in the rst rn:condition_else.
 , #rn:msg:ACCOUNT_SETTINGS_LBL# > account/profile

5. Save the le.
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Working with OpenLogin Widgets  
Four OpenLogin widgets appear on the login window of the standard and mobile reference implementations, and also
on the Create an Account form of both page sets.

There’s a separate widget for every open login provider, so you can congure these pages to include only the open login
providers you want. Any changes you make on the login window for open login options are applied to the Create an
Account form that is opened from the login window, but you can change the Create an Account page options separately.

Note:  The code for the default login window includes four OpenLogin widgets, but your page may not display
all of these widgets if your site is not congured for their use. The logos appear only if you have dened their
respective OAUTH_APP_ID and OAUTH_APP_SECRET on the administration interface.

When customers click one of the open login options, a message explains what will happen. The information is slightly
dierent depending on the external service the customer selects.

Related Topics
• Register Customer Portal Open Login with Facebook

• Register Customer Portal Open Login with Google

• Register Customer Portal Open Login with Twier

• Customer Portal Conguration Seing Keys

Redirect Customers After Login  
By default, customers will be redirected to the page they were on when they used open login after they have
successfully logged in. You can send them to a dierent page by dening the redirect_url aribute.

1. Open /views/pages/mobile/utils/login_form.php.
2. Locate the code for the widget you want to edit. This example uses the Google widget.

 <rn:widget path="login/OpenLogin" 

controller_endpoint="/ci/openlogin/openid/authorize/google" 

label_service_button="Google" 

label_process_explanation="#rn:msg:CLICK_BTN_GOOGLE_LOG_GOOGLE_VERIFY
_MSG#" 

label_login_button="#rn:msg:LOG_IN_USING_GOOGLE_LBL#" />

3. Add the redirect_url aribute to the widget code seing the value to the page where you want customers to be
redirected.

4. Save the le.
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Overview of the Create an Account Page and Form  
The Login page opens when customers click Log In or Sign Up and contains a Create an Account buon.

When that buon is clicked, a form opens where customers can enter contact information to create their account.
(Because they are required to complete the Display Name eld on this page, customers who create an account are
automatically registered as users for Community Self Service.)

In addition to using this form to let customers create an account, you can direct your customers to the reference
implementation Create an Account page. The page is found in the /views/pages/utils folder and contains the same
elds as the Create an Account form.

Just as the Login page lets your customers use an external service provider to log in to the Customer Portal, so do the
Create an Account form and page. You can also add elds to this page (including a global opt-in selection), remove
elds, and edit labels and message bases.

Edit the Password Label  
You can edit labels associated with most elds in Customer Portal.

1. Open /views/templates/mobile.php.
2. Locate sub:input_Contact.NewPassword:label_input="#rn:msg:PASSWORD_LBL#" in the rst AccountDropdown

widget.
3. Edit the label_input aribute to dene password length information.

sub:input_Contact.NewPassword:label_input="Password (8 characters minimum)"

4. Save the le.

Guided Assistance on the Customer Portal  
Guided assistance lets your customers nd the most appropriate answers to their questions by leading them through a
series of branching questions.

When answers are created on the administration interface for your organization’s knowledge base, they can be
associated with a specic guide. Then, whenever that answer is opened, customers are asked questions that lead them
to the correct answer for their particular situation. It’s also possible to specify a single guide that opens every time any
answer is viewed.

Creating a guide is done on the administration interface. There are recommended best practices for using guided
assistance on the mobile customer portal. Certain practices produce guides that are optimized for use on mobile
devices, while others produce a less-than-optimal result. For example, image questions can display poorly if the images
aren’t scaled for mobile displays.

• The best question types for mobile guides are Buon, Yes/No, Text, and Menu.

• Although the default conguration opens guides in a separate window, a beer customer experience will result
if you change the Answer Details page so it displays single answers inline on the page.

• Because mobile devices may not be able to open certain le types, avoid using guides that include answers
containing le aachments.

• Avoid long menu options to prevent wrapping display problems on a mobile device.
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• Avoid the use of wide elements, such as tables, images, and inline web pages, within a question’s content to
help prevent a confusing display, particularly since horizontal scrolling is not available on many mobile devices.

• Save answer responses for the last node in a guide to prevent the answer from taking control of the screen,
thereby preventing the customer’s return to the guide.

• Avoid list questions to prevent problems that can occur when customers’ previous responses do not display, as
sometimes happens on mobile devices.

• Restrict the use of images as much as possible for the best display with the fewest number of alignment issues
on the mobile display. Optimal image size is approximately 300 pixels. However, the mobile/site.css le will
automatically resize images within answer content.

• Displaying a single question at a time generally results in a beer customer experience than appending each
new question to the previous ones.

The default Answer Details page for the mobile customer portal includes the GuidedAssistant widget. A Launch the
Troubleshooter buon appears on the Answer Details page when an answer that is associated with a guide is opened.

When customers click the Launch the Troubleshooter buon, the rst question appears. Depending on the type of
question, customers may select a menu or list option, a buon, radio buon, or image, or type text in a eld.

After customers respond to the rst question, they can return to the previous screen and change their answer by
clicking the Go Back buon. Questions are presented one at a time on the mobile customer portal.

Note:  Note that clicking the mobile device’s Back buon may take customers back to the answer where the
guide was launched, it may return them to the device’s home page, or it may exhibit some other behavior.
Dierent mobile devices and operating systems implement the Back buon dierently.

Customers continue to answer questions that lead them to a solution in the form of a text explanation, an answer from
your knowledge base, a URL, or an external event. They may also be led to another guide that asks additional questions
until a solution is presented.

Conguring Guided Assistance  
You can use the conguration options to design the GuidedAssistant widget.

• Whether the guide opens in a separate window or inline

• Whether only one question is displayed at a time

• Whether the same guide opens with every answer

• Labels

◦ Label when the response is an answer from the knowledge base

◦ Launch buon label

◦ Back buon label

◦ Start over buon

◦ Label on the response buon that appears with text explanations

◦ Label when the response is a text explanation
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Open the Guide Inline  
By default, clicking the Launch the Troubleshooter buon opens the guide in a separate window that displays the
guided assistance page (/views/pages/mobile/utils/guided_assistant.php). We suggest that you set-up the customer
portal so guides open inline on the answer details page.

1. Open /views/pages/mobile/answers/detail.php.
2. Locate the following code.

<rn:widget path="knowledgebase/GuidedAssistant" popup_window_url="/app/utils/guided_assistant"
 label_text_result="#rn:msg:PLEASE_READ_THIS_RESPONSE_MSG#" />

3. Edit the GuidedAssistant widget to remove the popup_window_url aribute and add the
single_question_display aribute.
Your edited code is the following.
<rn:widget path="knowledgebase/
GuidedAssistant" single_question_display="true" label_text_result="#rn:msg:PLEASE_READ_THIS_RESPONSE_MSG#"/
>

4. Save the le.

Display Multiple Questions  
When the guide opens on the Guided Assistance page, the GuidedAssistant widget displays one question at a time, with
each new question displaying a buon that lets customers return to the previous question. The default behavior of the
GuidedAssistant widget is to display multiple questions on a page.

1. Open /views/pages/mobile/utils/guided_assistant.php.
2. Locate <rn:widget path="knowledgebase/GuidedAssistant" single_question_display="true"

label_question_back="#rn:msg:GO_BACK_CMD#" />.
3. Delete the single_question_display aribute from the code.

<rn:widget path="knowledgebase/GuidedAssistant" label_question_back="#rn:msg:GO_BACK_CMD#" />

4. Save the le.

Edit the GuidedAssistant Label  
You can edit the page to modify labels.

1. Open /views/pages/mobile/answers/detail.php.
2. Locate <rn:widget path="knowledgebase/GuidedAssistant" popup_window_url="/app/utils/guided_assistant"

label_text_result="#rn:msg:PLEASE_READ_THIS_RESPONSE_MSG#" />.
3. Add the label_popup_launch_buon aribute.

<rn:widget path="knowledgebase/GuidedAssistant" popup_window_url="/app/utils/guided_assistant"
 label_text_result="#rn:msg:PLEASE_READ_THIS_RESPONSE_MSG#" label_popup_launch_button="Start Here" />

4. Save the le.
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Edit Other Labels on the GuidedAssistant Widget  
You can edit the page to modify labels.

1. Open /views/pages/mobile/utils/guided_assistant.php.
2. Locate <rn:widget path="knowledgebase/GuidedAssistant" single_question_display="true"

label_question_back="#rn:msg:GO_BACK_CMD#" />.
3. To change the Go Back label that returns customers to the previous question in the guide, edit the

label_question_back aribute.
<rn:widget path="knowledgebase/GuidedAssistant" single_question_display="true"
 label_question_back="Previous Question" />

4. To change any of the other labels on the GuidedAssistant widget, add the associated label aribute to the
widget code and dene its value with the text you want.

◦ To edit the message displayed when the customer reaches a solution that is an answer from the
knowledge base, change the text in the label_answer_result aribute.
<rn:widget path="knowledgebase/GuidedAssistant" single_question_display="true"
 label_question_back="#rn:msg:GO_BACK_CMD#" label_answer_result="This information should answer
 your question."/>

◦ To edit the Start Over label when the customer reaches the end of the guide, add the label_start_over
aribute to the widget code.

◦ To edit the OK buon that customers click to enter a text response, add the label_text_response_buon
aribute to the widget code.

◦ To edit the message displayed when the customer reaches a text explanation, add the label_text_result
aribute.
<rn:widget path="knowledgebase/GuidedAssistant" single_question_display="true"
 label_question_back="#rn:msg:GO_BACK_CMD#" label_text_result="The following information answers
 your question." />

5. Save the le.

Change the Published and Updated Labels  
You can edit the page to modify labels.

1. Open /views/pages/mobile/answers/detail.php.
2. Locate this code.

 #rn:msg:PUBLISHED_LBL# <rn:field name="Answer.CreatedTime" />
 <br/>
 #rn:msg:UPDATED_LBL# <rn:field name="Answer.UpdatedTime" />

3. To edit the label, modify the text in front of the <rn:field name=.
 
 This answer was orginally published on <rn:field name="Answer.CreatedTime" />
 This answer was last updated on <rn:field name="Answer.UpdatedTime" />

4. Save the le.

Remove the Published and Updated Dates  
You can edit the page to modify the available elds.

1. Open /views/pages/mobile/answers/detail.php.
2. Delete the following lines of code.

 #rn:msg:PUBLISHED_LBL# <rn:field name="Answer.CreatedTime" />
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 <br/>
 #rn:msg:UPDATED_LBL# <rn:field name="Answer.UpdatedTime" />

3. Save the le.

Disable the File Aachments Display  
If les are aached to the answer displayed on the Answer Details page, the aachments will be displayed as part of the
answer unless you disable their display with this procedure.

1. Open /views/pages/mobile/answers/detail.php.
2. Delete this code.

 <div id="rn_FileAttach">
 <rn:widget path="output/DataDisplay" name="Answer.FileAttachments" label="#rn:msg:ATTACHMENTS_LBL#"/>
 </div>

3. Save the le.

Remove Related Answers  
By default, related answers appear on the answer details page if the answer being displayed is related to any other
answers in your knowledge base.

1. Open /views/pages/mobile/answers/detail.php.
2. Delete the following line of code.

 <rn:widget path="knowledgebase/RelatedAnswers" />

3. Save the le.

Disabling Answer Feedback  
There are a number of aributes that let you modify the buon labels.

The default Answer Details page uses the MobileAnswerFeedback widget to let customers provide feedback on the
answer they are viewing.

If customers answer Yes, their feedback is recorded and a thank-you message acknowledges the feedback. If they
answer No, they have an opportunity to provide additional feedback.

If customers select the link, another window opens where feedback can be entered. If customers are not logged in, the
Email eld is displayed and is required. If customers are logged in, only the Your Feedback eld is displayed.

You can edit all the labels on the MobileAnswerFeedback widget.

Aribute Default Label

label_cancel_buon
 

Cancel
 

label_comment_box
 

Your Feedback
 

label_dialog_prompt
 

Please tell us how we can make this answer more useful.
 

label_dialog_title
 

Rating submied
 

label_dissatised
 

We’re sorry this answer didn’t help.
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Aribute Default Label

label_email_address
 

Email
 

label_feedback_submit_success
 

Thanks for your feedback.
 

label_no_buon
 

No
 

label_provide_feedback
 

Would you like to provide feedback so we can make this answer more useful?
 

label_satised
 

Thanks for your feedback.
 

label_send_buon
 

Submit
 

label_title
 

Is this answer helpful?
 

label_yes_buon
 

Yes
 

If you don’t want to oer your customers the chance to oer answer feedback on the mobile implementation, you can
disable the feature.

Disable Answer Feedback  
You can edit the page to modify the available elds.

1. Open /views/pages/mobile/answers/detail.php.
2. Delete <rn:widget path="feedback/MobileAnswerFeedback" />.
3. Save the le.

Disabling the Ability to Email the Page  
The default Answer Details page lets customers email the displayed answer.

When customers are not logged in, the widget displays elds for the customer’s email address and name. Logged-in
customers need to enter only the recipient’s email address, as shown in the overlay on the right.

If you want to remove the ability for customers to email an answer, you can delete the EmailAnswerLink widget from the
answer details page.

Remove EmailAnswerLink  
You can edit the page to modify the available elds.

1. Open /views/pages/mobile/answers/detail.php.
2. Delete the following line of code.

 <rn:widget path="utils/EmailAnswerLink" />

3. Save the le.
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Logged-in Customers  
The dierences among the workows are apparent only when customers are not logged in.

When customers are logged in, the Ask a Question process is the same for all workows.

• The Ask a Question page opens without an Email Address eld because the customer is logged in (and,
therefore, the email address is known).

• The customer completes the elds and submits the question.

• Oracle Service Cloud converts the question into an incident, which is associated with the customer’s contact
record.

Email-only Default Workow  
If customers are not logged in when they select Email Us (from either the Contact Us section on the home page or by
clicking the Menu buon and selecting Contact Us > Email Us), they must enter their email address before submiing
their question.

If the email address matches an existing contact record, the resulting incident is associated with that contact record. If
the email address does not match an existing contact record, a new record is created for the customer and the incident
is associated with that record. The new contact record contains only the email address, so customers will be required
to use account assistance if they want to log in to the customer portal in the future. This workow is implemented by
default.

Although the default workow has been tested for its usability and adopted in the reference implementation, your
organization may require more customer information than just an email address. The best way to ensure geing this
information is to require customers to create an account before they can ask a question.

Editing the Ask a Question Page for the Email Check Workow  
By editing the Question page, you can verify and modify the workow.

First, you’ll edit the default Ask a Question page to achieve these objectives.

• Display the EmailCheck widget when customers are not logged in so they can enter their email address.

◦ If the email address matches an existing contact record, return customers to the Ask a Question page,
where the Email Address eld is populated.

◦ If the submied email address does not match a contact record in the knowledge base, take customers
to the Create Account page. The Email Address eld on this page is populated with the submied
information.

• Display the ProgressBar widget so customers who are in this workow can determine which step of the process
they’re currently on.
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Note:  Because the only step for logged-in customers is to complete the Ask a Question elds, the ProgressBar
widget is enclosed in conditional tags so it won’t appear to them. The ProgressBar widget includes a
current_step aribute that gets set from the EmailCheck widget’s redirect_after_contact_creation aribute.

Here is the code for the revised Ask a Question page (/views/pages/mobile/ask.php). It includes the EmailCheck and
ProgressBar widgets and the conditions for displaying them.

<rn:meta title="#rn:msg:ASK_QUESTION_HDG#" template="mobile.php" clickstream="incident_create"/>
<section id="rn_PageTitle" class="rn_AskQuestion">
 <h1>#rn:msg:ASK_OUR_SUPPORT_TEAM_A_QUESTION_LBL#</h1>
 <rn:condition logged_in="false" url_parameter_check="step != null">
 <rn:condition url_parameter_check="step == null">
 <rn:widget path="utils/ProgressBar"/>
 <rn:condition_else/>
 <rn:widget path="utils/ProgressBar" current_step="#rn:url_param_value:step#"/>
 </rn:condition> 
 </rn:condition>
</section>
<section id="rn_PageContent" class="rn_AskQuestion">
 <div class="rn_Padding">
 <!--Logged in or on final step of process-->
 <rn:condition logged_in="true" url_parameter_check="step == 3">
 <form id="rn_QuestionSubmit" onsubmit="return false;">
 <div id="rn_ErrorLocation"></div>
 <fieldset>
 <rn:condition logged_in="false">
 <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true" />
 <rn:widget path="input/FormInput" name="Incident.Subject" required="true" />
 <rn:condition_else/>
 <rn:widget path="input/FormInput" required="true" name="Incident.Subject" />
 </rn:condition>
 <rn:condition answers_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog" display_answers_inline="true"
 label_prompt="#rn:msg:FLLOWING_ANS_HELP_IMMEDIATELY_MSG#" accesskeys_enabled="false"
 label_solved_button="#rn:msg:MY_QUESTION_IS_ANSWERED_MSG#"
 label_cancel_button="#rn:msg:EDIT_QUESTION_CMD#" />
 </rn:condition>
 <rn:widget path="input/FormInput" name="Incident.Threads" required="true"
 label_input="#rn:msg:ADD_ADDITIONAL_DETAILS_CMD#"/>
 <rn:widget path="input/FileAttachmentUpload"/>
 <rn:widget path="input/MobileProductCategoryInput" />
 <rn:widget path="input/MobileProductCategoryInput" data_type="Category"/>
 <br/><br/><br/>
 <rn:widget path="input/FormSubmit" label_button="#rn:msg:CONTINUE_ELLIPSIS_CMD#" on_success_url="/app/
ask_confirm" error_location="rn_ErrorLocation" />
 </fieldset>
 </form>
 <rn:condition_else/> 
 <!-- Not logged in or on one of initial steps-->
 <rn:condition url_parameter_check="step == null">
 <p>In order to best answer your question, we need to have contact information for you. Please enter your
 email address below to start this process.</p>
 <rn:widget path="input/EmailCheck" initial_focus="true" redirect_existing_contact="/app/ask/step/3"
 redirect_after_contact_creation="/app/ask/step/3" redirect_new_contact="/app/utils/create_account/step/2" /
>
 </rn:condition>
 </rn:condition>
 </div>
</section>
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Edit the Create Account Page  
You want customers who access the page from the email check workow to see a progress bar so they know how far
along they are in the process of asking their question.

Although this procedure modies the default create account page, you may want to create a separate page for this
workow if your default page contains many elds. Because you’ve interrupted a customer who is trying to submit a
question, we recommend that you display only the minimum number of elds your organization requires to create an
account. Customers can then return quickly to the initial task.

This procedure checks the step parameter you added to the EmailCheck widget on the Ask a Question page. If the step
parameter in the URL is not null, the ProgressBar widget appears on the Create Account page.

1. Open /views/pages/mobile/utils/create_account.php.
2. Locate <h1>#rn:msg:CREATE_AN_ACCOUNT_CMD#</h1>.
3. Add this code immediately below the code you located in step 2.

<rn:condition url_parameter_check="step != null">
 <rn:widget path="utils/ProgressBar" current_step="#rn:url_param_value:step#"/>
</rn:condition>

4. Save the le.

Require Login on the Ask a Question Page  
Another workow approach is to simply require customers to log in before they can submit a question.

1. Open /views/pages/mobile/ask.php.
2. Locate the following line of code at the top of the le.

<rn:meta title="#rn:msg:ASK_QUESTION_HDG#" template="mobile.php" clickstream="incident_create"/>

3. Edit the code to add the login_required page meta tag.
<rn:meta title="#rn:msg:ASK_QUESTION_HDG#" template="mobile.php" clickstream="incident_create"
 login_required="true" />

4. Save the le.
5. Open /views/pages/mobile/ask_conrm.php.
6. Locate the following line of code at the top of the le.

<rn:meta title="#rn:msg:QUESTION_SUBMITTED_LBL#" template="mobile.php" clickstream="incident_confirm"/>

7. Edit the code to add the login_required page meta tag.
<rn:meta title="#rn:msg:QUESTION_SUBMITTED_LBL#" template="mobile.php" clickstream="incident_confirm"
 login_required="true" />

8. Save the le.

Add Contact Fields to the Ask a Question Page  
You can edit the page to modify the available elds.

1. Open /views/pages/mobile/ask.php.
2. Locate the lines of code between the <rn:condition logged_in="false"> condition tags.

<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
 label_input="#rn:msg:EMAIL_ADDR_LBL#"/>
<rn:widget path="input/FormInput" name="Incident.Subject" required="true" />

3. Add this code between the two widgets you located in the previous step.
<rn:widget path="input/FormInput" name="Contact.Name.First" required="true" />
<rn:widget path="input/FormInput" name="Contact.Name.Last" required="true" />
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4. Save the le.

Change the Answers Viewed or Searches Done Condition  
The default mobile Ask a Question page uses a condition tag to determine whether the SmartAssistantDialog widget
appears when the customer clicks the Continue buon or whether the conrmation page is displayed immediately.

1. Open /views/pages/mobile/ask.php.
2. Locate <rn:widget path="chat/ChatQueueSearch" popup_window="true"/>.
3. Edit the code to either delete or change the value of the answers_viewed or searches_done aributes.

This example code assumes you want to change the number of answers viewed and remove the requirement to
perform a search.
 <rn:condition answers_viewed="3">

4. Save the le.

Remove Conditions for SmartAssistantDialog  
If you remove the condition tags around the SmartAssistantDialog widget, it will always propose answers to your
customers before they can nish submiing their question, regardless of the number of answers they’ve viewed or
searches they’ve conducted.

You need to have set up a SmartAssistant incident rule in order for the widget to appear.
1. Open /views/pages/mobile/ask.php.
2. Locate the following lines of code.

 <rn:condition answers_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false" display_button_as_link=""/>
 </rn:condition>

3. Delete the two lines of code beginning with <rn:condition and the </rn:condition> line. All that should remain
is the code that calls the SmartAssistantDialog widget.

4. Save the le.

Change the Buons on SmartAssistantDialog  
The SmartAssistantDialog widget on the mobile Ask a Question page contains three buons: My Question is Answered,
Finish Submiing Question, and Edit Question. You can edit the labels for the buons, change their display order on the
dialog, or change the buons to links.

1. Open /views/pages/mobile/ask.php.
2. Locate <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false"

display_button_as_link=""/>.
a. To change the labels on the buons, add the label_solved_buon, label_cancel_buon, and

label_submit_buon aributes.
 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false" display_button_as_link=""
 label_solved_button="This answered my question" label_cancel_button="Return to my question"
 label_submit_button="I still need an answer"/>

b. To change the buons’ display order, add the buon_ordering aribute. (By default, the display order for
buons is label_solved_buon, label_submit_buon, label_cancel_buon.)
 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false" display_button_as_link=""
 button_ordering="label_submit_button, label_cancel_button, label_solved_button" />

c. To change the buons to links, edit the display_buon_as_link aribute.
 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false"
 display_button_as_link="label_solved_button, label_submit_button, label_cancel_button" />
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3. Save the le.

Redirect Customers when Questions are Answered  
By default, customers who click the My Question is Answered buon are redirected to the home page. If you want to
direct them to a dierent page, you can add the solved_url aribute to the SmartAssistantDialog widget.

1. Open /views/pages/mobile/ask.php.
2. Locate the following lines of code.

 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false" display_button_as_link="" />

3. Edit the widget code to add the solved_url aribute. Your code will resemble the following.
 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false" display_button_as_link=""
 solved_url="/app/answers/list"/>

4. Save the le.

Remove the SmartAssistantDialog Widget  
If you remove the SmartAssistantDialog widget, answers will never be suggested to your customers after they click the
Continue buon. Instead, the conrmation page will always open.

1. Open /views/pages/mobile/ask.php.
2. Delete this code.

 <rn:condition answers_viewed="2" searches_done="1">
 <rn:condition_else/>
 <rn:widget path="input/SmartAssistantDialog" accesskeys_enabled="false" display_button_as_link="" />
 </rn:condition>

3. Save the le.

Require Product and Category Levels  
The mobile ask a question page does not require that customers select a minimum number of product or category
levels related to their question, but you can edit the page to require them to select one or more levels of products or
categories.

If none of your products have end-user visibility specied, the product selection drop-down menu will not appear.
Similarly, the category menu will not appear if no categories have end-user visibility. Best practice recommends against
requiring product and category selection to prevent form abandonment by your customers.

1. Open /views/pages/mobile/ask.php.
2. Locate the following lines of code in the le.

 <rn:widget path="input/MobileProductCategoryInput" />
 <rn:widget path="input/MobileProductCategoryInput" data_type="Category" />

3. Add the required_lvl aribute to both MobileProductCategoryInput widgets to specify how many levels you
want your customers to select. If you want to require two levels of products and one level of categories, your
code will look like the following.
 <rn:widget path="input/MobileProductCategoryInput" required_lvl="2" />
 <rn:widget path="input/MobileProductCategoryInput" data_type="Category" required_lvl="1" />

4. To specify how many levels will be displayed to the customer, add the max_lvl aribute to the
MobileProductCategoryInput widgets.
If the value for required_lvl is greater than the value for max_lvl, the max_lvl value will be set equal to the
required_lvl value.
Your code will resemble the following.
<rn:widget path="input/MobileProductCategoryInput" required_lvl="2" max_lvl="4" />
<rn:widget path="input/MobileProductCategoryInput" data_type="Category" required_lvl="1" max_lvl="3" />
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5. Save the le.

Populate the Product Field  
You can edit the page to modify the available elds.

1. Open /views/pages/mobile/ask.php.
2. Locate the following line of code.

 <rn:widget path="input/MobileProductCategoryInput" />

3. Add the default_value aribute to the MobileProductCategoryInput widget to specify the product you just
identied the ID number for.
Your code will resemble the following.
 <rn:widget path="input/MobileProductCategoryInput" default_value="421,47" />

4. Save the le.

Aaching Files to Questions  
Your customers may want to aach image les to their questions, which they can do from their mobile device.

They can take a photo of a defective product or a screen shot of a program error and send it with their question.
Thumbnails appear next to the image name when les have been aached.

Note:  It’s possible that the image orientation might be dierent from the original sent by a customer, but sta
members working the incident on the Service Console can reorient the image, save it to their desktop, then
aach the correct orientation to the incident.

Requesting a Chat  
When customers click the Chat buon on the mobile customer portal, the Chat Launch page opens.

If the customer is logged in, the page displays rst and last names and email address. If the customer is not logged in,
elds for entering that information appear instead.

Changing the Message Bases  
You can edit the page to modify the labels and elds available.

You can change the default “Chat with our support team” and “Chat support is available” message bases on the Mobile
Chat Launch page.
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Change the Chat Heading and Labels  
You can edit the page to modify the available headings, labels, and elds.

1. Open /views/pages/mobile/chat/chat_launch.php.
2. To change the heading:

a. Locate <h1>#rn:msg:CHAT_WITH_OUR_SUPPORT_TEAM_LBL#</h1>.
b. Enter the new heading between the <h1> and </h1> tags.

3. To change the Chat Support Available message:
a. Locate <rn:widget path="chat/ChatStatus"/>.
b. Add the label_chat_available aribute to the code.

<rn:widget path="chat/ChatStatus" label_chat_available="Agents are currently available." />

4. Save the le.

Requiring an SLA  
You can require that customers have an SLA assigned before accessing certain pages or features of your site.

You can make the Chat Launch page content conditional on the customer having an SLA or you can simply add a meta
tag to the page to prevent customers without a chat SLA from requesting a chat. Customers who do not have an SLA
will see a Permission Denied message on the page, and customers who are not logged in will be directed to the Login
page so their SLAs can be checked.

Remove Fields from the Chat Launch Page  
You can edit the page to modify the available elds.

1. Open /views/pages/mobile/chat/chat_launch.php.
2. Locate the following lines of code.

 <fieldset>
 <rn:condition config_check="COMMON:intl_nameorder == 1">
 <rn:widget path="input/FormInput" name="Contact.Name.Last" label_input="#rn:msg:LAST_NAME_LBL#"
 required="true"/>
 <rn:widget path="input/FormInput" name="Contact.Name.First" label_input="#rn:msg:FIRST_NAME_LBL#"
 required="true"/>
 <rn:condition_else/>
 <rn:widget path="input/FormInput" name="Contact.Name.First" label_input="#rn:msg:FIRST_NAME_LBL#"
 required="true"/>
 <rn:widget path="input/FormInput" name="Contact.Name.Last" label_input="#rn:msg:LAST_NAME_LBL#"
 required="true"/>
 </rn:condition>
 <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
 label_input="#rn:msg:EMAIL_ADDR_LBL#"/>
 </fieldset>

3. To remove the Last Name eld and display only the rst name, delete the following line of code from both
condition cases.
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 <rn:widget path="input/FormInput" name="Contact.Name.Last" label_input="#rn:msg:LAST_NAME_LBL#"
 required="true"/>

4. To remove the Address eld, delete the following line of code.
 <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
 label_input="#rn:msg:EMAIL_ADDR_LBL#"/>

5. Save the le.

Add a Question Field on the Chat Launch Page  
You can give your chat agents a beer understanding of the chat topic by adding a eld on the Chat Launch page for
customers to enter their question.

1. Open /views/pages/mobile/chat/chat_launch.php.
2. Locate <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"

label_input="#rn:msg:EMAIL_ADDR_LBL#"/>.
3. Add <rn:widget path="input/FormInput" name="Incident.Subject" label_input="How can we help you today?"/>

immediately below the code you located in the previous step.
4. Save the le.

Set an SLA Condition for Displaying Page Content  
You can edit the page to require an SLA to display the page.

1. Open /views/pages/mobile/chat/chat_launch.php.
2. Locate the following line of code.

<section id="rn_PageContent" class="rn_LiveHelp">

3. Add the following line of code immediately before the code you located in step 2.
 <rn:condition sla="chat" />

4. Add the following code after the last line in the chat_launch.php le.
<rn:condition_else />
<div id="rn_PageContent" class="rn_AnswerDetail">
 <div class="rn_Padding">
 <h2>#rn:msg:PERMISSION_DENIED_LBL#</h2>
 <p>#rn:msg:CHAT_SLA_REQUIRED_LBL#</p>
 </div>
</div>
</rn:condition>

5. Save the le.

Set a Page Meta Tag to Require an SLA  
You can edit the page to require an SLA.

1. Open /views/pages/mobile/chat/chat_launch.php.
2. Add the sla_required_type page meta tag to the rst line of the le, which should now read:

 <rn:meta title="#rn:msg:LIVE_CHAT_LBL#" template="mobile.php" clickstream="chat_request"
 sla_required_type="chat" />
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3. Save the le.

Note:  If you require a chat SLA on the chat launch page, you should also require one on the chat page.
Edit the chat_landing.php le in the same manner by adding sla_required_type="chat" to the rst line
in the le.

Conguring ChatTranscript  
You can edit the widget to modify labels and other display items.

The ChatTranscript widget lets you replace the default icons and labels that appear on the transcript window.

Note:  Hyperlinks are disabled in the chat transcript to prevent customers from following a link and then being
unable to return to the chat session.

Replacing ChatTranscript Widget Icons  
You can replace any of the default icons, which are specied as aributes of the ChatTranscript widget, by dening the
path and le name for the replacement icon.

This is the code for the ChatTranscript widget in the chat_landing.php le.

<rn:widget path="chat/ChatTranscript" mobile_mode="true"/>

Seing the mobile_mode aribute to true disables the Close buon, making customers use the Menu buon to navigate
away from the chat window.

All default icons are stored in the /cp/customer/assets/themes/mobile/images folder. You can reference the path in
widget aributes by entering images/[filename].

Icon Aribute Default Value

Agent Message Icon agent_message_icon_path images/chatAgent.png

Alert Icon alert_icon_path images/chatAlert.png

End-user Message Icon enduser_message_icon_path images/
chatEndUserMessage.png

O the Record Icon o_the_record_icon_path images/
chatOTheRecord.png

To replace the default Agent Message icon, for example, the code resembles this.

<rn:widget path="chat/ChatTranscript" agent_message_icon_path="images/chatAgentNew.png" />
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Edit the ChatPostMessage Label  
By default, the ChatPostMessage label on the mobile Chat Page says, “Type your message and send.”

1. Open /views/pages/mobile/chat/chat_landing.php.
2. Locate <rn:widget path="chat/ChatPostMessage"

label_send_instructions="#rn:msg:TYPE_YOUR_MESSAGE_AND_SEND_LBL#" mobile_mode="true"/>.
3. Edit the label_send_instructions aribute to change the default message base.

<rn:widget path="chat/ChatPostMessage" label_send_instructions="Your new instructions for sending a
 message" mobile_mode="true"/>

4. Save the le.

Add the Option to Chat O-the-Record  
You can add a buon to the Mobile Chat page that lets customers send an o-the-record message during the chat
session.

1. Open /views/pages/mobile/chat/chat_landing.php.
2. Locate <rn:widget path="chat/ChatEngagementStatus"/>.
3. Add this code immediately below the line you located in the previous step.

<rn:widget path="chat/ChatOffTheRecordDialog"/>
<rn:widget path="chat/ChatOffTheRecordButton" off_the_record_icon_path=""
 label_off_the_record="#rn:msg:SEND_AN_OFF_THE_RECORD_MESSAGE_CMD#"/>

4. Save the le.

Set all Chat Posts O-the-record  
You can edit the page to change the chat record options.

1. Open /views/pages/mobile/chat/chat_landing.php.
2. Locate the following line of code.

 <rn:widget path="chat/ChatPostMessage"
 label_send_instructions="#rn:msg:TYPE_YOUR_MESSAGE_AND_SEND_LBL#" mobile_mode="true"/>

3. Edit the widget to add the all_posts_o_the_record aribute, as shown in the following code.
 <rn:widget path="chat/ChatPostMessage"
 label_send_instructions="#rn:msg:TYPE_YOUR_MESSAGE_AND_SEND_LBL#" mobile_mode="true"
 all_posts_off_the_record="true" />

4. Save the le.

Conguring Other Chat Widgets  
You can congure other chat widgets.
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Although only three widgets are required for a working chat page, these additional chat widgets provide increased
functionality.

• ChatSoundBuon

• ChatEngagementStatus

• ChatQueueWaitTime

• ChatCancelBuon

• ChatQueueSearch

• ChatPrintBuon

• ChatOTheRecordBuon

• ChatDisconnectBuon

• ChatAgentStatus

• ChatAachFileBuon

• ChatSendBuon

• ChatOTheRecordDialog

• ChatRequestEmailResponseBuon

• ChatCobrowsePremium

These chat widgets are not available on the mobile customer portal.

• ChatAachFileBuon

• ChatPrintBuon

• ChatQueueSearch

• ChatSoundBuon

Edit the Support History Heading  
The default heading for the mobile Support History page is Search Your Support History.

1. Open /views/pages/mobile/account/questions/list.php.
2. Locate <h1>#rn:msg:SEARCH_YOUR_SUPPORT_HISTORY_CMD#</h1>.
3. Edit the code to replace the message base with the new page heading between the <h1> tags.

<h1>Search your recent questions here</h1>

4. Save the le.

Remove Product and Category Filters  
By default, the support history pages lets customers lter their incidents by product and category.

1. Open /views/pages/mobile/account/questions/list.php.
2. Delete the following lines of code.

 <rn:widget path="navigation/Accordion" toggle="rn_Advanced"/>
 <div class="rn_Padding">
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 <a class="rn_AlignRight" href="javascript:void(0);" 
id="rn_Advanced">#rn:msg:PLUS_SEARCH_OPTIONS_LBL#</a>
 <div>
 <rn:widget path="search/MobileProductCategorySearchFilter" 
filter_type="products"/>
 <rn:widget path="search/MobileProductCategorySearchFilter" 
filter_type="categories"/>
 </div>
 </div>

3. Save the le.

Collapse the Update This Question Section  
By default, the Update This Question section is expanded when the mobile Question Details page opens.

1. Open /views/pages/mobile/account/questions/detail.php.
2. Locate this code.

<div class="rn_Module">
 <rn:widget path="navigation/Accordion" toggle="rn_QuestionUpdate"/>
 <h2 id="rn_QuestionUpdate">#rn:msg:UPDATE_THIS_QUESTION_CMD#<span class="rn_Expand"></span></h2>
 <form id="rn_UpdateQuestion" onsubmit="return false;">
 <div id="rn_ErrorLocation"></div>
 <rn:widget path="input/FormInput" name="Incident.StatusWithType.Status"
 label_input="#rn:msg:DO_YOU_WANT_A_RESPONSE_MSG#"/>
 <rn:widget path="input/FormInput" name="Incident.Threads"
 label_input="#rn:msg:ADD_ADDTL_INFORMATION_QUESTION_CMD#" initial_focus="true" required="true" />
 <rn:widget path="input/FileAttachmentUpload"
 label_input="#rn:msg:ATTACH_ADDTL_DOCUMENTS_QUESTION_LBL#"/>
 <rn:widget path="input/FormSubmit" label_button="#rn:msg:SUBMIT_CMD#" on_success_url="/app/account/
questions/list" error_location="rn_ErrorLocation"/>
 </form>
</div>

3. Edit the code to add the <class="rn_Collapsed"> element.
<div class="rn_Module">
 <rn:widget path="navigation/Accordion" toggle="rn_QuestionUpdate"/>
 <h2 id="rn_QuestionUpdate"><class="rn_Collapsed">#rn:msg:UPDATE_THIS_QUESTION_CMD#<span
 class="rn_Expand"></span></h2>
 ...
</div>

4. Save the le.

Expand Communication History When the Page Opens  
You can edit the page to change the displayed communication history.

1. Open /views/pages/mobile/account/questions/detail.php.
2. Locate this code.

<h2 id="rn_QuestionThread">#rn:msg:COMMUNICATION_HISTORY_LBL#<span 
class="rn_Expand"></span></h2>
<div class="rn_Hidden rn_QuestionThreadContent">

3. Edit the code to include the rn_Expanded class.
<h2 id="rn_QuestionThread" 
class="rn_Expanded">#rn:msg:COMMUNICATION_HISTORY_LBL#<span 
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class="rn_Expand"></span></h2>
<div> 

4. Save the le.

Expand Additional Details When the Page Opens  
You can edit the page to change the display of additional details.

1. Open /views/pages/mobile/account/questions/detail.php.
2. Locate this code.

<h2 id="rn_QuestionDetails">#rn:msg:ADDITIONAL_DETAILS_LBL#<span 
class="rn_Expand"></span></h2>
<div class="rn_Hidden rn_Padding">

3. Edit the code to add the rn_Expanded class.
<h2 id="rn_QuestionDetails" 
class="rn_Expanded">#rn:msg:ADDITIONAL_DETAILS_LBL#<span 
class="rn_Expand"></span></h2>
<div class="rn_Padding">

4. Save the le.

Edit Labels on the Question Details Page  
You can edit any of the message bases, including eld labels, on the Question Details page.

1. Open /views/pages/mobile/account/questions/detail.php.
2. Locate <h2 id="rn_QuestionUpdate">#rn:msg:UPDATE_THIS_QUESTION_CMD#<span class="rn_Expand"></span></h2>.
3. Edit the message base to include your customized label.

 <h2 id="rn_QuestionUpdate">Provide updated information<span class="rn_Expand"></span></h2>

4. Save the le.

Edit the Account Seings Page Title  
You can edit the page to modify the available labels, titles, headings, and elds.

1. Open /views/pages/mobile/account/prole.php.
2. Locate <h1>#rn:msg:ACCOUNT_SETTINGS_LBL#</h1>.
3. Edit the code with your new heading.

<h1>Your Current Profile Settings</h1>

4. Save the le.

Edit Message Bases on the Account Seings Page  
You can edit any of the message bases and labels on the Account Seings page.

1. Open /views/pages/mobile/account/prole.php.
2. To change the “Change your password” message:

a. Locate <a href="/app/account/change_password#rn:session#">#rn:msg:CHG_YOUR_PASSWORD_CMD#</a><br/
><br/>

b. Edit the code with your new message.
<a href="/app/account/change_password#rn:session#">Click here to change your password.</a><br/
><br/>
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3. To change the label for the Email Address eld:
a. Locate <rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"

validate_on_blur="true" label_input="#rn:msg:EMAIL_ADDR_LBL#" />

b. Edit the code with your new message.
<rn:widget path="input/FormInput" name="Contact.Emails.PRIMARY.Address" required="true"
 validate_on_blur="true" label_input="Your primary email address" />

4. Save the le.

Add or Remove Contact Fields on the Account Seings Page  
You can edit the page to modify the available elds and labels.

1. Open /views/pages/mobile/account/prole.php.
2. To add one or more contact elds, insert the appropriate code.

◦ To add the alternate email address elds to the page, add this code.
 <rn:widget path="input/FormInput" name="Contact.Emails.ALT1.Address" />
 <rn:widget path="input/FormInput" name="Contact.Emails.ALT2.Address" />

◦ To add a radio buon selection that lets customers opt in to communications
from your marketing department, add <rn:widget path="input/FormInput"
name="Contact.MarketingSettings.MarketingOptIn" /> to the block of FormInput widgets on the page.

3. To remove one of the contact elds, locate the line of code that displays the eld and delete it.
4. Save the le.

Edit Message Bases on the Change Password Page  
You can edit the page to modify the available message bases, labels, and elds.

1. Open /views/pages/mobile/account/change_password.php.
2. To edit the heading,

a. Locate <h1>#rn:msg:CHANGE_YOUR_PASSWORD_CMD#</h1>.
b. Enter the new heading between the <h1> tags.

3. To edit labels for any of the password elds, locate this code:
<rn:widget path="input/PasswordInput" name="Contact.NewPassword" require_validation="true"
 require_current_password="true" label_input="#rn:msg:PASSWD_LBL#"
 label_validation="#rn:msg:VERIFY_PASSWD_LBL#" initial_focus="true"/>

a. To edit the Current Password label, add the label_current_password aribute and set its value to the label
you want.

b. To edit the Password label, edit the value for the label_input aribute.
c. To edit the Verify Password label, edit the value for the label_validation aribute.

4. Save the le.

Edit Password Label on the Change Password Page  
If you set a minimum password length that customers must enter when they’re creating an account or changing their
password, passwords are automatically required.

1. Open /views/pages/mobile/account/change_password.php.
2. Locate <rn:widget path="input/FormInput" name="Contact.NewPassword" require_validation="true"

label_input="#rn:msg:PASSWD_LBL#" label_validation="#rn:msg:VERIFY_PASSWD_LBL#" initial_focus="true"/>.
3. Edit the label_input aribute of the FormInput widget to dene password length information.

<rn:widget path="input/FormInput" name="Contact.NewPassword" require_validation="true"
 label_input="Password (8 characters minimum)" label_validation="#rn:msg:VERIFY_PASSWD_LBL#"
 initial_focus="true"/>
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4. Save the le.

Developer Information  
The mobile reference implementation oers a JavaScript Module meta tag that enhances performance of the customer
portal on mobile devices.

Another dierence between the mobile and standard reference implementations is the styling of the development
header and the information it contains. In order to automatically display the mobile page set to customers with mobile
devices, the customer portal provides user agent mapping so you can dene the page sets your customers see based
on the browser they are using.

JavaScript Module Meta Tag  
To support the higher latency on mobile browsers, a new page meta tag called javascript_module has been added.

If this tag is omied, the same framework JavaScript as used in the standard reference implementation is loaded.
Selecting the mobile option for this tag loads core components, but omits large and unnecessary modules. No
deprecated code will be loaded, and the autoload.js le will not be loaded either.
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7  Chat Conguration

Overview of Chat  
Though self-service and email response management can solve the majority of customer issues, one-on-one
interaction remains the best venue and value for certain queries.

With Oracle RightNow Chat Cloud Service (Chat), you can provide access to agents for customer questions and issues
that merit human interaction between your supervisors and agents, and agents and customers through real-time chat
sessions. You must congure Chat for supervisors, agents, and customers to take advantage of these functions. To get
started, become familiar with the following interactions.

• The administrator congures chat for sta and customers.

• The Chat component manages connections, pushes chats to agents, and creates incidents from chats.

• The supervisor manages agents and monitors agents and chats.

• The agent chats with customers, suggests answers, conferences another agent, transfers customers, and
cobrowses with customers.

• The customer submits a chat request, searches the knowledge base, reviews suggested answers, and
cobrowses with agents.

After you implement Chat for your application, you can measure its eectiveness using powerful analytics. See Real-
Time Reports and Chat Audit Report.

Related Topics

How You Congure Chat for Supervisors and Agents  
When conguring Chat, it is important that you set certain conguration options before others.

Chat session queues must be added to Oracle Service Cloud before they will display in proles, and proles must
be added or updated before they can be assigned to agents. We recommend that you congure Chat options in the
following order.

Note:  Conguration options will not be visible until Chat is enabled. To enable Chat, contact your Oracle
account manager.

1. Add chat session queues. See Add or Edit a Chat Session Queue.
2. Add chat agent statuses. See Add or Edit a Chat Agent Status.
3. Add chat reports to navigation sets. See Chat Reporting.
4. Add or update proles to include Chat permissions. See Add Chat Permissions to a Prole.
5. Add or update sta accounts to use proles that include Chat permissions. See Add or Edit a Sta Account.
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Add or Edit a Chat Session Queue  
Chat session queues, when used with proles and business rules, enable automatic sorting of incoming chats based on
contact, organization, product, category, and custom eld information.

A wireless communications organization, for example, might have agents that specialize in dierent types of sales
products or services. You could add chat session queues such as cell phones and wireless service. You would then create
proles that let agents access the dierent queues and assign the appropriate prole to your agents based on their area
of expertise.

Tip:  The following chat conguration seings are not interface specic; the seing in the primary interface
takes precedence:

• AVERAGE_WAIT_TIME_SAMPLES

• ESTIMATED_WAIT_TIME_SAMPLES

• IDLE_QUEUE_WAIT_TIME_RESET_SECONDS

• MIN_WAIT_INFO_UPDATE_SECONDS

Seing each conguration seing in additional interfaces to the same value as the primary interface avoids
confusion. See Overview of Multiple Interfaces.

Business rules, which perform actions on incoming chat requests based on specic conditions, can be used to
automatically assign incoming chat requests to specied chat session queues. This ensures that chat requests are
routed to the appropriate agent based on the agent’s skill set. See Overview of Business Rules.

Note:  If you try to delete a chat session queue that is used in a business rule, a message displays the rules
that depend on the queue. Before you can delete the chat session queue, you must rst edit the rules so they
no longer use the queue.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Click the arrow next to the System Menus folder to expand the list.
4. Click Chat Queues to display the editor.

Chat has one default chat session queue named Default Chat Queue. The name of the default queue can be
changed, but the queue cannot be deleted. All incoming chat requests are routed to the Default Chat Queue
unless new queues are added and business rules are implemented to route chats to the new queues.

5. Do one of the following:

◦ To add a chat session queue, click New to display the editor.

◦ To edit a chat session queue, click it in the list.

6. Enter the name of the chat session queue in the Label eld.
When using multiple-language interfaces, you must enter the name in the Label eld in the language of the
interface.
The same name is added to the Label eld in the Interface Visibility section.

7. To designate the queue for use with advanced routing of chat requests, select the Advanced Routing check
box and enter eld information. See How You Congure Advanced Routing for Chat.
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Field Description

Starting Minimum Score Enter a value from 0 to 5 for each skill. Incoming chats will be rst routed to those
agents meeting this score.

Lowest Minimum Score Enter a value from 0 to 5 for each skill. Only agents meeting this minimum skill level can
be assigned chats from this queue.

Relax Score Requirement After Enter a value in seconds for the queue. The score requirement will be relaxed after the
time you specify. Skills are relaxed at the queue level. A value of 0 seconds disables skill
relaxation.

Score Decrement Amount Enter the score value from 1 to 5 for each skill to be decremented when it meets the
relaxation time.

Overow Timer Enter a value in seconds after which the chat will be routed equally to agents assigned
the queue as a primary or an overow. Overow will be disabled if this eld is set to 0,
 and only agents assigned the queue as a primary will receive chats from this queue.

8. To designate the queue for use with third-party-initiated chat requests, select the External check box.
The read-only VA Enabled check box is used to designate the queue for use with virtual assistant initiated chat
requests.

9. To change the order in which chat session queues display on the editor, select the queue, and click Move Up or
Move Down.

10. Click Save.

Related Topics
• How You Congure Virtual Assistant

Add or Edit a Chat Agent Status  
An agent’s status describes his or her availability to chat with customers as well as assist supervisors and other agents
with their chats.

Although Chat contains default chat agent statuses, you can create custom agent statuses and associate them with
either the Available or Unavailable status type. While working in Chat, agents can change their status as necessary. By
default, Chat has ve chat agent statuses that are assigned to three chat status types.

• Available—The Available status type signies that the agent is available to chat.
◦ Unrestricted—The Unrestricted status indicates that there are no restrictions to an agent’s availability to

chat.

• Unavailable—The Unavailable status type signies that the agent is not available to chat.
◦ Unqualied—The Unqualied status indicates that the agent did not specify a reason for being

unavailable to chat.
◦ In Meeting—The In Meeting status indicates that the agent is in a meeting and is not available to chat.

◦ On Break—The On Break status indicates that the agent is on a break and is not available to chat.

• Logged Out—The Logged Out status type is restricted to the Unspecied chat agent status type and cannot be
modied.
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◦ Unspecied—The Unspecied status indicates that the agent is logged out of Chat. This chat status does
not display to sta on the Agent Status drop-down menu.

The default chat agent statuses may be enough for your organization. However, if additional chat agent statuses will
help you more accurately determine the status of agents, then you can add them.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree displays on the content pane.
3. Click the arrow next to the System Menus folder to expand the list.
4. Click Chat Agent Statuses to display the editor.
5. Do one of the following:

◦ To add a chat agent status, click New to display the editor.

◦ To edit a chat agent status, click it in the list.

The In Meeting and On Break default chat agent statuses and custom chat agent statuses can be deleted.
6. Enter the name of the chat agent status in the Label eld.

The same label is added to the Label eld in the Interface Visibility section.
7. Click the Status drop-down menu and select a status type. The options include Available, Unavailable, and

Logged Out.
After you save a chat agent status, you can change its label but not its status.

8. To change the order in which chat agent statuses display on the editor, select the status and click Move Up or
Move Down.

9. Click Save.

When you add a chat agent status, you must assign it to one of the default status types and then make it available
through the Chat Agent Statuses section in proles. See Add Chat Permissions to a Prole.

Related Topics
• Live Media Bar

Chat Reporting  
Agents and supervisors use chat reports to view and monitor chat activity.

Chat reports are available in Public Reports/Service/Chat Reports and include real-time reports that are refreshed
at a default rate of fteen seconds or less, and a chat audit report. You can view the reports and, with appropriate
permissions, edit them inline or delete selected chats. Reports that can be edited or have chats deleted must include
rst name, last name, email, IP address, or subject elds.

For editing a chat report inline, the report must have inline editing enabled and your prole must include Edit
permission for chats.

For deleting a selected chat, the report must have the delete command enabled and your prole must include Delete
permission for chats. You can only delete one chat at a time. When chats are deleted, they will no longer display on the
Chat Conversion by Agent report.
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Related Topics
• Real-Time Reports

• Chat Audit Report

• Add a Real-Time Chat Report to a Navigation Set

• Add Chat Permissions to a Prole

• Monitor a Chat Session

• Enable Inline Editing

Real-Time Reports  
Real-time reports and dashboards are available for Chat.

Real-time reports and dashboards are available in Public Reports/Service/Chat Reports/Real-Time Reports. All of
the reports include a default refresh rate of fteen seconds or less.

Report Description

Active Chat List Per Agent
 

This report displays information about active chats that are assigned to agents.
 

Active Chat List Per Queue
 

This report displays information about active chats in queues.
 

Chat Agent Home–Real Time
 

This dashboard is a real-time alternative to the Chat Agent Home dashboard located in Public
Reports/Service/Chat Reports.
 

Chat Agent List Per Queue
 

This report displays information about agents and their assignment to queues.
 

Chat Agent Queue Snapshot
 

This report displays information about an agent’s current chats.
 

Chat Supervisor Home–Real Time
 

This dashboard is a real-time alternative to the Chat Supervisor Home dashboard located in Public
Reports/Service/Chat Reports.
 

Chat Supervisor Queue Snapshot
 

This report displays information about each engagement in a queue.
 

Current Chat Agent Statistics
 

This report displays statistics for individual agents.
 
The Chats in Last Hour column is non-functional, and displays 0, for the virtual assistant. See How You
Congure Virtual Assistant.
 

Current Chat Group Statistics
 

This report displays statistics for agent groups.
 

Current Chat Queue Statistics
 

This report displays statistics for chat queues.
 

My Chat Agent Statistics
 

This report displays basic statistics for the current agent.
 

Waiting Chat List Per Queue This report displays information about waiting chats in queues.
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Report Description

   

Chat Audit Report  
The Chat Audit report is a top-level report that provides a 360-degree view of chat data during a selected time period.

The report includes drill-down links into associated audit detail reports and is available in Public Reports/Service/Chat
Reports/Audit Reports.

Tip:  To view column denitions in the Chat Audit report, hover over the column headings.

Add a Real-Time Chat Report to a Navigation Set  
Add real-time chat reports so sta members can view a dashboard of their chat activity.

Before sta members chat with customers, we recommend that you add the applicable real-time chat reports to their
navigation sets so they can view a dashboard of their chat activity. See Real-Time Reports.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer opens on the content pane.
3. Double-click the navigation set used by your agents.

The content pane displays the Navigation Sets editor.
4. On the right side of the content pane, select Communication Center.

All Communication Center items display in the lower portion.
5. On the left side of the content pane, expand Public Reports/Service/Chat Reports/Real-Time Reports to

open the folder with real-time chat reports.
6. To congure the navigation set for agents, drag Chat Agent Home–Real Time from the left column and drop it

in the lower portion of the right column.
7. To congure the navigation set for supervisors, drag Chat Supervisor Home–Real Time from the left column

and drop it in the lower portion of the right column.
8. Click Save.

The navigation set containing Chat Agent Home or Chat Supervisor Home must be selected in the Interfaces section on
the Prole editor. See Add Chat Permissions to a Prole.

Related Topics
• Overview of Navigation Sets

Add Chat Permissions to a Prole  
Chat is not fully functional until sta members have been assigned as agents.

After you create or edit a prole containing Chat permissions, you can then assign the prole to individual sta
members. This lets you designate which sta members have access to Chat. You can assign Chat permissions to one or
more proles based on your organization’s needs.

1. Click Conguration on the navigation pane.
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2. Expand Sta Management, and then double-click Proles.
The report opens on the content pane.

3. Double-click the prole you want to edit.
The Proles editor opens.

4. Click Permissions.
5. Click the Service tab and scroll down to Chat permissions.
6. Enter eld information.

Field Description

Chat Agent Permissions Select the Select All check box to select all options in the Chat section.
If you do not want agents having full chat permissions in their prole, you must clear the
check boxes next to the functions you do not want agents to access.
 

Chat Select to let sta members with this prole chat with customers.

Supervisor Select to let sta members with this prole have supervisory permissions in Chat.

Monitor Select to let supervisors with this prole monitor other agents.
This check box cannot be selected unless the Supervisor check box is selected, as
monitoring can be performed only by supervisors.
 

Conference/Transfer to Other
Groups

Select to let sta members conference with agents in other groups and transfer
customers to agents in other groups.
Agents can always conference with agents in their own group and transfer customers to
agents within their own group.
 

Pull Chat Select to let agents pull chats from the wait queue.
By default, the chat server automatically pushes chat requests to agents. If the Pull Chat
check box is selected, a corresponding pull policy must be selected so that chat requests
are oered to agents when they click Request Chat on the Live Media bar.
 

Allow Decline Select to let agents with this prole manually decline chat requests.
If Allow Decline is selected, but Auto Decline is not, chats will automatically be assigned
to agents if they click X on the top of toast invitations. To decline chats, agents must
click Decline on toast invitations.
 

Auto Decline Select to let the system automatically decline chat requests when the toast notication
expires.
The chat toast expiration timeout can be congured through the CHAT_ALERTFORM_
AUTOCLOSE_TIMEOUT conguration seing.
 

Set Max Active Chats Select, and in the associated Max Active Chats eld enter the maximum number of
active chat sessions that a sta member can be engaged in.
The value set in this eld also determines the value that displays in the Maximum Active
Chats eld on the Oracle Service Cloud Options window. See Change Your Chat Options.
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Field Description

 

Set Delay Between Chats Select, and in the associated Delay Between Chats eld enter the number of seconds
that elapse before a new chat is presented to an agent.
The value set in this eld determines the value that displays in the Stagger Incoming
Chats eld on the Oracle Service Cloud Options window.
 

Edit Select to let sta members edit existing chats.

Delete Select to sta members delete chats.

*Max Active Chats Enter the maximum number of active chat sessions that a sta member can be engaged
in. The minimum value for this eld is 1, the maximum value is 11, and the default value
is 3.

*Max Total Chats Enter the maximum number of total chat sessions, both active sessions and those that
are in wrap-up mode, that a sta member can be engaged in. The minimum value for
this eld is 1, the maximum value is 20, and the default value is 3.

*Delay Between Chats Enter the number of seconds that elapse before a new chat is presented to an agent.

Virtual Assistant Prole This read-only check box is used to designate the prole for use with virtual assistant
initiated chat requests.

Enable Advanced Routing Select to designate the prole for use with advanced routing.

Chat Queues Click to select the chat queue you want to be available for this prole, and click +. After
selecting a queue, the queue can be moved up or down in the queue list. If needed, you
can then select additional chat queues to associate with this prole.
An agent must be assigned to a chat queue to log in to Chat and accept chat requests
from customers.
 

Pull Policy Click to select a pull policy that determines the queues that chat requests are retrieved
from and their order.
Strict priority—Uses the priority ranking of the available queues to determine which
queue to pull chats from, starting with the highest ranking queue. Chats are pulled from
this queue until the sta member’s active session limit is met or the queue is empty. If
the queue is empty before the sta member’s limit is met, then chats are pulled from
the queue with the next highest priority ranking.
 
First due—Uses the order that chats were requested to determine which chats are
sent to sta members. The rst chat requested is the rst chat pulled from a queue.
Chats are pulled from all the sta member’s available queues in the order the chats
were requested until the sta member’s maximum session limit is met or all queues are
empty. Queue ranking will not aect the pull order.
 

Advanced Routing - Chat Queues Click to select the advanced routing chat queue you want to be available for this prole,
and click +. After selecting a queue, click the drop-down menu to designate it as Primary
or Overow and its order of priority. The queue can be moved up or down in the queue
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Field Description

list. If needed, you can then select additional advanced routing chat queues to associate
with this prole.

Chat Agent Statuses This section contains panels for moving chat agent statuses between the Available and
Assigned lists. Chat agent statuses are added through the Chat Agent Statuses editor.

Available The Available list displays chat agent statuses that are not available to agents on the
Agent Status drop-down menu located on the Live Media bar. Select a status and click
Add to move the status to the Assigned list.

Assigned The Assigned list displays chat agent statuses that are available to agents on the Agent
Status drop-down menu located on the Live Media bar. Select a status and click Remove
to move the status to the Available list.
By default, Logged Out–Unspecied is selected so agents are not automatically logged
in to Chat when they log in to Oracle Service Cloud. Select Available–Unrestricted to
automatically log agents in to Chat (and make them available) when they log in to Oracle
Service Cloud.
 

7. Click Save.

Before agents can use Chat, you must assign a prole containing chat permissions to their sta accounts. See Add or
Edit a Sta Account.

Related Topics
• How You Congure Virtual Assistant

• How You Congure Advanced Routing for Chat

• Change Your Chat Options

• Add or Edit a Chat Session Queue

• Add or Edit a Chat Agent Status

Standard Chat Workspace  
Chat contains a standard chat session workspace that is used by supervisors and agents. The workspace determines
what sta members see when they chat with customers or among themselves.

You can use the standard workspace or create custom workspaces by copying one to use as a starting point. You assign
a workspace in the prole used by agents. If you do not assign a workspace, the system uses the default. The workspace
used for chaing on the Agent Browser UI uses a dierent default standard workspace, the interaction workspace, that
may also be customized.

Chat sessions—The chat sessions workspace displays when an agent accepts a chat from a customer or when a
supervisor monitors a chat. It consists of information about the customer plus Engagement, Incidents, Page Peek, and
View Browser History tabs.

• The Engagement tab consists of a Transcript section (where the chat session is recorded to) and a Compose
section (where you enter your responses to customers).
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• The Incidents tab contains a list of incidents previously submied by customers, so you can review any
correspondence that customers had with other agents prior to the chat session.

• The Page Peek tab is where you view a snapshot of the web page that the customer was viewing when the chat
was initiated.

• The Visitor Browser History tab is where you view a list of up to fteen URLs tracking the pages of your
organization’s website that the customer was viewing prior to initiating the chat. The amount of time browser
history is retained is congured using the VS_PURGE_NON_PAGELOAD_EVENT_DAYS conguration seing
(Agedatabase/Batch Processing/Visitor Service).

Note:  Engagement Engine must be enabled in order to congure and use page peek and visitor browser
history. To enable page peek and visitor browser history, contact your Oracle account manager. We
recommend creating a custom chat workspace and removing these tabs if you are not using page peek or
visitor browser history.

Additional Chat Conguration Options  
Powerful conguration options are available for Chat.

You can set service level requirements to ensure agents respond to customers in a timely manner, for example, or set up
standard text to increase agent eciency when responding to contacts. Chat can be integrated with guided assistance
so agents can present guides to contacts when they are chaing with them. Chat can also be integrated with Oracle
RightNow Feedback Cloud Service (Feedback) so that contacts are presented with a survey at the conclusion of a chat
session.

Service Level Requirements for Chat  
Chat has congurable service level requirements that let you set realistic service goals for your agents and reasonable
expectations for your customers.

You can dene the amount of time that elapses before a customer tab changes from green to yellow, indicating to the
agent that the customer is waiting for a response. The Chat service level conguration seings are located in Chat/
General/Service Level. See How You Customize Conguration Seings and Chat with a Customer.
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Agent and System Service Level Statistics  
From the Chat Agent Home dashboard, agents can view chat statistics, such as the available chat queues, the number of
current chat sessions, active chats, waiting customers, average wait time, and average chat duration.

By default, all cumulative statistics are a representation of system activity for the last thirty minutes and are updated
each minute. By conguring agent service level statistics, you can congure both the reporting, or “lookback” period,
and the frequency of updates to meet your requirements. The agent service level statistics conguration seings are
located in Chat/General/Service Level.

See How You Customize Conguration Seings and Chat with a Customer.

Standard Responses and URLs for Chat Sessions  
By creating standard responses and URLs for agents to use during chat sessions, your agents can save valuable time by
not having to type answers for commonly asked questions or URLs.

A Shortcut eld lets agents quickly insert standard text responses and URLs during a chat session. To view the shortcut
ID code, agents can hover over the response or URL entry to see the shortcut ID. Entering the shortcut ID in the Shortcut
eld and pressing Enter automatically sends the response or URL to the customer. For additional information about
conguring standard text and URLs, see Add or Edit Standard Text.

Tip:  If your organization uses variables in standard text, such as contacts.rst_name, agents can enter (or
copy and paste) the variable inline when responding to a customer. The variable is then replaced with the
appropriate data before the response is sent to the customer. For additional information about conguring
variables, see Add or Edit a Variable.

Related Topics
• Overview of Content Library

How You Congure Pulling Chats from the Wait Queue  
By default, chats are automatically pushed to agents, but this functionality is congurable.

If you select the Pull Chat check box in an agent prole, agents can manually pull chat requests from the wait queue. If
the Pull Chat check box is not selected, the Request Chat and Cancel Request buons are disabled on the Live Media bar
and chats are pushed to agents by the system.

Note:  If the Pull Chat check box is selected, you must also select a pull policy. See Add Chat Permissions to a
Prole.

By clicking the Request Chat buon, the agent is requesting to pull a chat from the wait queue. If there is a chat in the
wait queue, the agent will receive a toast notication that the agent can either accept or decline. If the wait queue is
empty, the Request Chat buon remains active, leing the chat server know that the agent is aempting to request the
next chat that enters the wait queue.

How You Create Incidents from Chat Sessions  
Chat sessions can be captured as incidents, leing you track all chat correspondence.

By default, an incident is created when a chat sessions begins. However, this functionality is congurable so that an
incident can be created when a chat session ends or when prompted. In addition, incident elds can be added to
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the chat session workspace for viewing and editing purposes. By conguring the chat sessions workspace, you can
customize this functionality to meet your organization’s needs.

Note:  To create an incident when a chat session ends or with a prompt, you must copy the standard chat
sessions workspace. The copied workspace will contain an Options buon on the ribbon, which you can use to
customize incident creation and editing. If you do not copy the chat sessions workspace, incident creation is
dictated by the default behavior. Contact your Oracle account manager for more information.

The following default actions are performed at the conclusion of the chat session.

• The agent is prompted to enter wrap-up mode or to terminate the session. Wrap-up mode lets agents complete
any post-chat tasks before automatically receiving the next chat request.

• If a customer account does not exist for the customer, a new customer account is created and a contact record
is added to the knowledge base. If the email address eld is not enabled on the Live Help page, the eld is set to
a generic email address (chat@nodomain.com).

• The Assigned eld is set to the agent who participated in the chat session.

• The incident custom elds you have made visible on the Live Help page are updated.

• The chat conversation appears as a chat transcript on the Messages tab of the incident.

• The Subject eld is populated with Chat Session.

• The status of the incident is set to Solved.

Related Topics
• Congure Incident Creation and Editing for Chat

Congure Incident Creation and Editing for Chat  
By default, an incident is created when a chat sessions begins. However, this functionality is congurable so that an
incident can be created when a chat session ends or when prompted.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces.

The Workspaces explorer opens on the content pane.
3. Click the Standard folder in the Workspaces tree.
4. Right-click the Chat Sessions workspace and select Copy.
5. Select the folder you want to add the copied workspace to.
6. Enter a name for the copied workspace in the Name eld.
7. Click OK.

The workspace displays on the explorer in the folder that you selected.
8. Double-click the new workspace.

The workspace opens on the content pane.
9. Click Options.

The Chat Options window opens and the Related Incident Options tab displays by default.
10. Select related incident options.

Option Description

Create/associate related incident at
the beginning of a chat (if one does
not exist)?

Select from the following options.
 

◦ Yes
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Option Description

  ◦ No

◦ Prompt agent

This option is set to Yes by default.
 

Open related incident for editing
at the beginning of a chat (if one
exists)?
 

Select from the following options.
 

◦ Yes

◦ No

◦ Prompt agent

This option is set to No by default. This feature is not available for the enhanced Service
Console.
 

Create/associate related incident at
the end of a chat (if one does not
exist)?
 

Select from the following options.
 

◦ Yes

◦ No

◦ Prompt agent

This option is set to No by default.
 

Open related incident for editing at
the end of a chat (if one exists)?
 

Select from the following options.
 

◦ Yes

◦ No

◦ Prompt agent

This option is set to No by default. The incident opens only when Wrap-up is selected to
end a chat.
 

Discard previous related incident
if it is uncommied when another
incident is associated to chat?
 

Select from the following options.
 

◦ Yes

◦ No

◦ Prompt agent

This option is set to No by default.
 

Set status to solved for incidents
created automatically.
 

Select this check box to set the incident’s status to Solved if it is not automatically
opened by Oracle Service Cloud.
 
This check box is selected by default.
 

11. Click the Other Options tab.
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12. Select other options.

Option Description

Data Synchronization
 

This section contains an option to synchronize common elds across related records.
For example, both the chat sessions and contact workspaces include an Email eld that
is synchronized for data consistency purposes.
 

Synchronize common elds across
related records automatically
 

Select this check box to enable data synchronization between the following elds.
 
chats.email and contacts.email
 
chats.rst_name and contacts.rst_name
 
chats.last_name and contacts.last_name
 
chats.c_id and incidents.c_id
 
This feature is disabled by default.
 

Wrap-up Behavior
 

This section contains options for conguring wrap-up mode, which lets agents
complete any post-chat tasks before automatically receiving the next chat request.
 

Automatically release chat after
wrap-up
 

Select this check box to automatically release a chat after wrap-up mode has ended.
 
This feature is enabled by default. This feature is not available for the enhanced Service
Console.
 

Automatically close editor after chat
is terminated
 

Select this check box to close the incident workspace after the chat has ended.
 
This feature is enabled by default. This feature is not available for the enhanced Service
Console.
 

Prompt the agent to enter wrap-up
mode
 

Select this check box to prompt agents to enter wrap-up mode.
 
This feature is enabled by default.
 

Wrap-up time (seconds)
 

Enter the number of seconds to specify the maximum time allowed for chat sessions to
wrap up.
 
This option is set to 45 seconds by default. If it is set to zero, agents will be prompted
when the chat disconnects to terminate or enter wrap-up mode if the Prompt the agent
to enter wrap-up mode option is selected.
 

13. Click Save.
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After conguring the custom workspace, it must be assigned to one or more proles. See Proles.

How You Congure the Preliminary Screen Pop  
Preliminary screen pop functionality enhances toast notications that agents view before accepting chats.

The preliminary screen pop displays as a two-column table that lets agents view additional information about chat
requests.

The information that displays on the preliminary screen pop table can be specied for the Service Console using the
CHAT_ALERTFORM_DISPLAY conguration seing. Note that any changes made will not aect the display on the Agent
Browser UI. You can also disable the preliminary screen pop using the CHAT_ALERTFORM_ENABLED conguration
seing. Both seings are located in Chat/General/Agent. See How You Customize Conguration Seings.

Related Topics
• Chat with a Customer

Enable Sneak Preview  
Sneak Preview lets agents view chat dialog as it is being entered by the customer before the customer sends the
message.

Sneak Preview is not enabled by default. Through conguration seings for individual interfaces, you can enable Sneak
Preview and specify the time interval sneak preview data is sent to the agent. See How You Customize Conguration
Seings. You must be using CP framework version CPv3.5 or later for Sneak Preview.

Note:  Sneak Preview should only be enabled in accordance with your company’s privacy and security
requirements.

1. To enable Sneak Preview, set the SNEAK_PREVIEW_ENABLED conguration seing to Yes.
2. Set the SNEAK_PREVIEW_INTERVAL_MS conguration seing to specify the interval in milliseconds that the

chat session sends sneak preview data to the agent.
The default value is 3000 milliseconds (3 seconds).

Feedback for Chat  
You can gather feedback during or after a chat session.

You have the ability to either send an invitation message to the customer containing a link to the survey during the
chat session (website link survey), or have a browser window containing a survey open at the end of the chat session
(transactional survey). Customer responses to the surveys are linked back to the chat session to facilitate reporting. See
Overview of Surveys.
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If you are creating a transactional survey, you must also create a business rule to trigger the survey upon completion of
the chat session. See Overview of Business Rules.

Guided Assistance for Chat  
Guided assistance guides can be added to custom chat sessions workspaces to assist agents as they chat with
customers.

For information about adding the Guided Assistance control to a custom chat sessions workspace, see How Fields Are
Added to Workspaces and Scripts. For information about how agents use guides while chaing with customers, see
Access Guided Assistance During a Chat Session.

Chat Presence Management  
Presence management ensures that chat participants are notied when either the agent or the customer experiences
communication diculties with the chat service.

By default, if the chat service does not receive signals from an agent or customer within two minutes, the chat service
begins the process of disconnecting the agent or customer and handling any active chats in which either party is a
participant. Presence management is available on a per-site basis. Because agents and customers are recognized
by the chat service as existing in an active, absent, or disconnected state, three conguration seings are available
for modifying the intervals in which agents and customers are recognized by the chat service. The chat presence
management conguration seings are located in Chat/General/Chat Session.

Proactive Chat  
With the proactive chat widget, you can oer a chat invitation to customers while they are using your website.

The proactive chat widget is accessed from the customer portal. You can congure the chat widget to select when the
chat invitation is displayed to the customer based on the time the customer has spent on the page and the number of
searches conducted as well as chat agent availability and estimated wait time. See Overview of Chat on the Customer
Portal.

Chat Data Purging  
Because chat data can potentially build up quickly, it can be purged according to conguration seings.

Conguration seings for purging chat data are located in Agedatabase Utility/Chat Purging.

CAUTION:  When chat data is purged, it is permanently deleted from the database. If you need assistance with
chat data purging, submit a service request on our  support site .

How You Congure Advanced Routing for Chat  
You can route incoming chats to agents with specic language or product skills. Routing chats to agents with a specic
skill set ensures that customers’ questions are answered accurately and eciently.

Products and categories selected by the customer and the language of the customer portal page from which the
chat was initiated determine which agent skills are required. If your customer is viewing the English version of the
customer portal when they initiate the chat, connecting them to a chat agent uent in English is going to provide the
best experience. If your customer is looking for information about your newest product, connecting them to a chat
agent who is an expert with that product is going to provide the quickest resolution. When a chat is initiated, if there
is no agent logged in with the specic skill required by your customer, advanced routing relaxes the skill requirement
immediately to prevent the chat from becoming stuck in the queue.
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You can also use advanced routing primarily for the queue overow capabilities without dening skills.

You can track the performance of advanced routing of chat sessions using standard reports available in Public
Reports/Service/Advanced Routing.

Note:  Advanced routing reports and conguration options will not be visible until Chat and Smart Interaction
Hub are enabled. To enable, contact your Oracle account manager.

You must complete the following tasks before you can congure and use advanced routing for incoming chats.

1. Dene products and categories. See Search Optimization Using Products, Categories, and Dispositions.
2. Add product and category elds to the Live Help page of the customer portal. See Overview of Chat on the

Customer Portal.
3. Create an advanced routing chat queue. See Add or Edit a Chat Session Queue.
4. Create and activate a rule to route chats to the advanced routing chat queue. See Overview of Business Rules.
5. Assign advanced routing permissions to a prole. See Add Chat Permissions to a Prole.

Additionally, if you are using advanced routing with products or categories, you must congure skills and sta account
skill scores to nish the conguration and begin using advanced routing for incoming chats. See Assign the Skill Edit
Permission in Proles, Add Skills, and Assign Skill Scores to a Sta Account.

Assign the Skill Edit Permission in Proles  
Assign the Skill Edit permission in proles for advanced routing.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to edit.

The Proles editor opens.
4. Click Permissions.

The Permissions page opens.
5. Select the Skill Edit check box in the Administration section on the Administration tab.
6. Click Save.

You must add Product Skills and Language Skills to the navigation set. See Edit a Navigation Set.

Add Skills  
Add skills for advanced routing.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Language Skills or Product Skills.

The Skills editor displays on the content pane.
3. Do one of the following:

◦ To add a skill, click New to display the editor.

◦ To edit a skill, click it in the list.

You can delete a skill at any time by selecting the skill entry in the tree and clicking Delete. However, when you
delete a skill, all instances of the skill will also be deleted.

4. Enter eld information.
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Field Description

Skill Information This section denes the name and type of the skill.

*Skill Name Enter the name of the skill.

Template ID This read-only eld identies the type of skill.

Label Select the interface.

Characteristics This section species the language, product, or category for the skill.

Language Select a language from the drop-down menu.
This eld is available only on the Language Skills editor.
 

Product Select a product from the drop-down menu.
This eld is available only on the Product Skills editor.
 

Category Select a category from the drop-down menu.
This eld is available only on the Product Skills editor.
 

5. Click Save.

Assign Skill Scores to a Sta Account  
Assign skill scores to a sta account for advanced routing.

You can assign skills to a sta account at the prole level or at the individual sta account level. Skills assigned at the
prole level are inherited by sta accounts assigned to that prole, but skills can be modied and added to individual
sta accounts.

1. Click Conguration on the navigation pane.
2. Do one of the following:

◦ To assign skills to a prole, expand  Sta Management, double-click Proles, and then double-click the
prole you want to edit. The Proles editor opens.

◦ To assign skills to a sta account, expand Sta Management, double-click one of the sta account
reports, and then double-click the individual account you want to edit. The Account Details editor opens.

3. Click Skills.
The Account Skill Scores window opens.

4. Select the Product or Language tab.
5. To add a product or language:

a. Select the product or language from the drop-down menu.
b. Click the green + (plus) sign.
c. Assign the skill an account score from the drop-down menu.

6. To modify a skill at the account level that was inherited by a prole, click the blue arrow next to the skill score.

Note:  Changing an agent’s inherited skill score to 0 is not the same as assigning an agent to a prole
without that skill. After the advanced routing queue has relaxed to a score of 0, the chat will be routed
to an agent with a skill score of 0. The chat will only be routed to an agent assigned a prole without
the skill if no other agents with that skill are logged in.
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7. To delete a skill, click the red X next to the skill score.
Skills assigned at the prole level can only be deleted at the prole level.

8. Click Save.

Assign Engagement Engine Rules Permissions in Proles  
Engagement engine rules give you greater control over when, where, and how proactive and reactive chats are provided
to your customers.

Engagement engine rules must be enabled. Contact your Oracle account manager.
1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to edit.

The Prole editor opens.
4. Click Permissions.

The Permissions page opens.
5. Select  Engagement Engine Rules on the Administration tab.
6. Click Save.
7. Add the Engagement Engine Rules item to your conguration list for the Conguration buon.

See Create a Navigation Set for the Administrator.

Access the Engagement Engine Rules Editor  
Engagement engine rules give you greater control over when, where, and how proactive and reactive chats are provided
to your customers. A robust set of built-in rule conditions regarding customer behavior and page data determine the
initiation of a chat oer.

Engagement engine rules must be enabled. Contact your Oracle account manager.
1. Double-click Engagement Engine Rules in the conguration list.

The Engagement Engine Rules editor login screen opens on the content pane.
2. Enter your user ID, password, and account ID, provided by your Oracle account manager.
3. Click Log In.

The Engagement Engine Rules editor opens on the content pane.
4. For detailed procedures about creating and editing engagement engine rules, click Help.

For more information about Oracle Engagement Engine, see the  Oracle Engagement Engine Cloud Service Online
Documentation Library .

Visitor Browser History  
Visitor browser history gives you more information about what your customers were viewing prior to initiating a chat.

A list of up to fteen URLs tracking the pages of your organization’s website displays on the visitor browser history tab
of the chat workspace. Visitor browser history provides agents with valuable information about what customers were
viewing before requesting a chat. An agent’s prole must include access to the primary interface for visitor browser
history to display.

Note:  Engagement engine must be enabled and all pages of your organization’s website that you want
to track must contain the engagement engine tag. Contact your Oracle account manager. See Oracle
Engagement Engine Cloud Service for more information.
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How You Congure Chat for Customers  
Many options are available for customizing Chat to match your business requirements.

Because the chat pages are integrated with the customer portal, they are highly congurable.

Note:  Chat must be enabled in order for your customers to chat with agents. Contact your Oracle account
manager.

See the following conguration topics:

• The Live Help Page

• Chat Page Conguration

• How You Congure Virtual Assistant

The Live Help Page  
The Live Help page on the customer portal is your customers’ entry point for submiing chat requests.

Within each section you can place incident custom elds to gather additional information before customers can engage
in chat. See Overview of Chat on the Customer Portal.

See Set Chat Hours to control when customers can submit chat requests.

Set Chat Hours  
You can set chat hours for Chat availability to control when customers can submit chat requests.

The available chat hours you set are displayed on the Live Help page. Outside of those chat hours, customers cannot
request assistance. You can also specify more than one set of chat hours per day to allow for multiple time periods in a
single day (for example, if you wanted to oer chat during peak trac times only, such as 8:00 A.M. to 12:00 P.M. and
1:00 P.M. to 5:00 P.M.).

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Interfaces.

The Interfaces tree displays on the content pane.
3. Click the interface for which you want to add chat hours.

The Interfaces editor displays on the content pane.
4. Click Chat Hours.

The Chat Hours page opens.
Chat hour intervals will always be entered at the boom of the list, but when you save your changes, the
intervals are arranged in chronological order.

5. Enter eld information.
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Field Description

Chat Intervals Edit the following elds to set chat hour intervals.

Day Click in this eld and select the day of the week from the drop-down menu.
Use this functionality to specify more than one set of chat hours per day to allow for
multiple time periods in a single day.
 

*Start Hour Enter the hour of the day that you want the service interval to begin. This eld uses the

24-hour clock. For example, enter 8 for 8:00 A.M and enter 17 for 5:00 P.M.

*Minute Enter the minute of the hour that you want the service interval to begin.

*End Hour Enter the hour of the day that you want the service interval to end. This eld uses the

24-hour clock. For example, enter 8 for 8:00 A.M and enter 17 for 5:00 P.M.

*Minute Enter the minute of the hour that you want the service interval to end.

Holidays Select the holidays that will aect your chat hours. Chat hours will not be available
during selected holidays.
If you have not dened any holidays, this eld is blank.
 

6. Click Save.
The chat hours will now appear on the Live Help page of the customer portal.

Related Topics
• Overview of Chat on the Customer Portal

• Overview of Service Level Agreements

Chat Page Conguration  
Because your organization has its own image and web presence, you may want to customize the Chat page to match the
look and feel your customers have come to expect.

The Chat page opens after customers submit chat requests from the Live Help page. From this page, customers can
chat with agents, send le aachments, and print chat correspondence. You can customize the look and feel of the Chat
page.
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To learn more about Chat and how agents interact with customers while chaing, see Chat for Agents.

Related Topics
• Overview of Chat on the Customer Portal

How You Congure Virtual Assistant  
If your site is integrated with Oracle RightNow Virtual Assistant Cloud Service (Virtual Assistant), you can route incoming
chats to a virtual assistant.

For complete information about Virtual Assistant, see  Using Virtual Assistant .

Using virtual assistant chats, you can ease the volume of chats requiring an agent. Many customer questions can
quickly be answered with existing information in the knowledge base. Agent chats and virtual assistant chats can be
initiated, routed, and tracked through the Service Console.

Note:  The Virtual Assistant component must be enabled in both Oracle Service Cloud and Virtual Assistant.
Contact your Oracle account manager.

After Virtual Assistant is enabled, you need to perform the following steps so incoming chats can be routed to the
virtual assistant.

1. Assign the Virtual Assistant Edit permission to your prole—You will need this permission in order to congure
the virtual assistant for your application. See Add Virtual Assistant Edit Permissions to a Prole.

2. Add the Virtual Assistant editor to a navigation set—All conguration takes place on this editor. See Add the
Virtual Assistant Editor to a Navigation Set.

3. Create the virtual assistant prole, account, and chat queue—In this step, you will dene the virtual assistant
name that will display to customers during a chat and the chat queue that will handle incoming chats and
escalation. After you ll in this information and save it to the database, the virtual assistant prole is created
automatically. See Create a Virtual Assistant Prole, Account, and Queue and Add or Edit a Chat Session Queue.

4. Create chat rules to route virtual assistant chats and escalate virtual assistant chats to agents when necessary.
Upon escalation, you can view a complete transcript of the virtual assistant chat leading to a smooth transition
from virtual assistant to agent. See Route Chats to Virtual Assistant for steps to create rules.
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Add Virtual Assistant Edit Permissions to a Prole  
Add Virtual Assistant edit permissions to a prole to congure the Virtual Assistant.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to edit.

The Proles editor opens.
4. Click Permissions.
5. Select the Virtual Assistant Edit check box in the Administration section on the Administration tab.
6. Click Save.

Add the Virtual Assistant Editor to a Navigation Set  
Add the Virtual Assistant editor to a navigation set for Virtual Assistant conguration.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer opens.
3. Right-click the navigation set you want to edit and select Open.

The navigation set opens on the content pane.
4. Click Conguration on the right side of the content pane.

The folders and conguration items associated with this buon display in the lower portion of the right column.
5. Expand the Components list and Common folder in the left column.
6. Click the Virtual Assistant Editor item and then click Add.
7. Click Save.

Create a Virtual Assistant Prole, Account, and Queue  
Dene the virtual assistant name that will display to customers during a chat and the chat queue that will handle
incoming chats and escalation. After you ll in this information and save it to the database, the virtual assistant prole is
created automatically.

You can have only one virtual assistant account and one virtual assistant queue. After they are created, the virtual
assistant prole, account, and queue cannot be deleted. However, you can change the names of the virtual assistant
account and queue using the Virtual Assistant editor.

1. Click Conguration on the navigation pane.
2. Double click Virtual Assistant Editor in the list.
3. Enter the name for the virtual assistant in the Display Name eld.

This is the account name that will be displayed to customers during a chat.
4. Enter the name for the virtual assistant chat queue in the Virtual Assistant Queue eld.

This is the name of the chat queue that you will use to congure rules to handle incoming chats and escalation.
5. Click Save.

The virtual assistant prole (automatically labeled VA_Accounts_Prole), virtual assistant account, and virtual
assistant queue are created.

In order to complete the conguration and begin routing incoming chats to the virtual assistant, you must create chat
rules. See Route Chats to Virtual Assistant.

Route Chats to Virtual Assistant  
Create business rules to route chats to the virtual assistant queue and to escalate chats to an agent when certain
conditions are met.
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You must congure a Virtual Assistant account, prole, and queue before routing chats to Virtual Assistant. See Create a
Virtual Assistant Prole, Account, and Queue.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, then double-click Rules.
3. Click Chat.
4. Click Edit to enter the edit mode.
5. Create an Initial State, if one doesn’t exist, and a state named VA_State.

a. Right-click States.
b. Select New State.
c. Enter the name of the state (either Initial State or VA_State)in the State Name eld.
d. Select the Initial State check box if this is the Initial State.
e. Click Save.

The state appears in the Rules tree.
6. Right-click Initial State, then select New Rule.

The Edit Chat Rule window opens.
7. Enter the name of the rule in the Rule Name eld.

For example, name the rule VA_Rule.
8. Click Add IF Condition Based On, then select the eld, operator and value for the condition.

For example, you may want to route all incidents of a specic type to the virtual assistant queue.
9. Click Add Action–Then to choose the action that will be executed if the conditions are met.

For example, create an Assign Chat Queue action to assign chats to the Virtual Assistant chat queue, and a
Transition State and Stop with VA_State selected.

10. Click Save.
The rule to route chats to the Virtual Assistant chat queue is saved.

11. Right-click VA_State, then select New Rule.
The Edit Chat Rule window opens.

12. Enter the name of the rule in the Rule Name eld.
For example, name the rule Escalation.

13. Click Add IF Condition Based On, then select the same condition values you specied for the VA_Rule.
14. Click Add Action–Then to choose the action that will be executed if the conditions are met.

For example, create an Assign Chat Queue action to assign chats to the chat queue used to escalate to a live
agent, and a Stop Processing Rules action.

15. Click Save.
The rule to escalate chats to a chat queue used by a live agent is saved.
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8  Chat

Chat for Agents, Supervisors, and Customers  
While self-service and email response management can solve the majority of customer issues, Oracle RightNow Chat
Cloud Service (Chat) oers the best venue for certain queries, such as helping customers nalize purchases.

• Chat for Agents

• Chat for Supervisors

• Chat for Customers

Chat for Agents  
As a chat agent, you can serve customers in real time through typed conversation.

While chaing, you can send predened responses and URLs to customers, oering a faster response time. When you
need assistance with a chat session, you can conference another agent into a chat or transfer a chat to another agent.
Both the conference and transfer features can be useful if another agent is more knowledgeable in a particular area.

By default, when you begin chaing with a customer, Chat creates an incident from the chat session, which results in all
correspondence being recorded to the knowledge base for resolution and reporting purposes.

Live Media Bar  
With the Live Media bar, you can log in, log out, and set your status in Chat.

Chat must be enabled and your prole must include chat permissions to log in as an agent from the Live Media bar. You
can request chats and cancel chat requests, manage active chat sessions, and view the status of your connection with
the chat server.

The Live Media bar appears on the content pane regardless of which navigation list is selected or what is displayed on
the content pane.

Buon Description

Login Chat Click to log in to Chat. The Agent Status drop-down menu (located next to Login) is enabled.
This buon appears only when you are logged out.
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Buon Description

Logout Chat Click to log out of Chat. The Agent Status drop-down menu (located next to Logout) is disabled.
This buon appears only when you are logged in.
 

Agent Status Click this drop-down menu to select an agent status type and status.
Chat contains default agent status types of Unavailable and Available. By default, the Unavailable
status type is selected, but your administrator can select Available as your default status type. In
addition, your administrator can add custom statuses and select any of them as the default.
 

Available This status type signies that you are available to chat.

Unavailable This status type signies that you are not available to chat.

In Meeting This status indicates that you are in a meeting and unavailable to chat.
By default, this status does not display on the Agent Status drop-down menu.
 

On Break This status indicates that you are on a break and unavailable to chat.
By default, this status does not display on the Agent Status drop-down menu.
 

Request Chat Click to request (pull) a chat from the queue.
By default, chats are pushed to you by the system. This buon is enabled only if Pull Chat permission is
set in your prole and you are available to chat.
 

Cancel Request Click to cancel a chat request after it has been pulled from the queue.
By default, chats are pushed to you by the system. This buon is enabled only if Pull Chat permission is
set in your prole, you are available to chat, and the Request Chat buon is not active.
 

Active Chats If you are chaing with multiple customers, click this drop-down menu and select a chat session
to participate in. When you are not chaing with customers, the drop-down menu is disabled and
displays No Chats. When you are engaged in a chat session, the name of the customer you are chaing
with displays in the menu.
The color of the selections in the Active Chats drop-down menu correspond to the customer tab colors.
 

Connectivity A symbol with all green bars signies that your connection to the Oracle server is excellent. A symbol
with yellow bars signies that your connection to the Oracle server is intermediate, but could be beer.
A symbol with a small red bar signies that your connection to the Oracle server is poor. A symbol with
white bars covered by a red circle signies that you are logged out of Chat.

Related Topics
• Chat with a Customer

Log in to Chat  
Log in to Chat and view Chat–Real Time reports.

1. Click Communication Center on the navigation pane.
2. Double-click Chat Agent Home–Real Time or Chat Supervisor Home–Real Time in the navigation list.

The dashboard opens on the content pane.
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The Chat Agent Home–Real Time dashboard refreshes every fteen seconds or less, depending on server
load. The following reports display on the Chat Agent Home dashboard.

◦ Chat Agent Queue Snapshot—Shows the service statistics for each chat queue that the logged-in agent
is assigned to.

◦ My Chat Agent Statistics—Shows chat agents their basic chat statistics, including average response time,
engaged time, and chats completed.

◦ Current Chat Queue Statistics—Shows the service statistics for all of the chat queues.

Note:  If the Chat Agent Home–Real Time or Chat Supervisor Home–Real Time reports do not
display in your navigation list, you can add it if you have the correct prole permission. See How You
Customize Navigation and Conguration Lists.

3. Click Login Chat on the Live Media bar.
4. Click Agent Status and select Available.

Your administrator can congure your prole so that you are automatically logged in and available to chat after
logging in to Oracle Service Cloud.

Related Topics
• Real-Time Reports

Change Your Chat Options  
Visual and audible alerts are available to notify you when customers request to chat or when they update existing chat
sessions. You can change certain seings to provide the most eective assistance possible.

1. Click File and select  Options  > Communication Center  to view chat options.

2. Select chat notication options.

Field Description

Incoming Chat Assignment
Notication

Incoming Chat Notication options apply only to new chat requests.

Flash Window Select to ash the minimized window on the Windows task bar whenever a new chat
arrives.
This option is selected by default.
 

Play Sound Select to enable an incoming sound alert whenever a new chat arrives.

Show Toast Select to display a toast notication whenever a new chat request arrives.
This option is selected by default.
 

Incoming Chat Post Notication Incoming Chat Post Notication options apply only to existing chats that are updated by
the customer.

Flash Window Select to ash the minimized window on the Windows task bar whenever a chat is
updated by the customer.
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Field Description

This option is selected by default.
 

Play Sound Select to enable sound alerts whenever the chat is updated by the customer.

Color Window Select to change colors on the customer tab as time passes to alert you that you need to
respond to the customer.
This option is selected by default. If this option is not selected, a colored icon will display
on the customer tab whenever the customer updates the chat session.
 

Incoming Chat Assignment
Control

Incoming Chat Assignment Control options apply only to new chat requests.

Maximum Active Chats This number represents the maximum number of chat sessions that you can have
active at one time. Click the up arrow to increase sessions and click the down arrow to
decrease sessions.
The maximum number is set by your administrator in your prole.
 

Stagger Incoming Chats (Seconds) This number represents the amount of time that elapses before you are oered another
chat. Click the up arrow to increase seconds and click the down arrow to decrease
seconds.

3. Click OK to save your chat notication seings.

Chat Sessions Workspace  
It is important to familiarize yourself with the chat sessions workspace before chaing with customers.

Your main role is to chat with customers and access tools to answer their questions. This is accomplished through the
chat sessions workspace.

This image shows the standard chat sessions workspace for an agent after accepting a chat request from a customer.
Keep in mind that what you see may be dierent if your administrator has created a custom chat sessions workspace
and assigned it to your prole.
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Notice in the image the customer’s name on the content pane tab. Additional tabs will display when you are engaged in
multiple chat sessions.

After you accept a chat request, read-only customer elds display at the top of the content pane. See View Incidents
Submied by a Customer. Much of the information listed on the content pane is also provided in the toast invitation you
see before accepting the chat request.

Chat Ribbon  
While chaing with customers, multiple chat agent tools are available on the chat ribbon.

Buon Description

Undock
 

Click to undock the chat workspace editor from the console and display it in a separate window.
 

Terminate
 

Click to terminate the chat session.
 

Wrap-up
 

Click to conclude the chat and enter wrap-up mode.
 
Wrap-up mode lets you do any post-chat tasks before automatically receiving the next chat request.
Tasks can include creating an incident from the chat, adding the chat to an existing incident, or
creating an opportunity from the chat.
 

Join
 

Click to join a chat session while monitoring a chat.
 
This buon is disabled until you begin monitoring a chat session.
 

Leave
 

Click to leave a chat session during a conference.
 
For this buon to be enabled, you must be the agent who was conferenced into the chat.
 

Transfer
 

Click to transfer the customer to another agent.
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Buon Description

Conference
 

Click to conference another agent into your chat.
 

Change Lead Role
 

Click to select the lead chat agent.
 
You must be involved in a conference session for this buon to be enabled.
 

Add to New Incident
 

Click to create an incident from the chat session while the chat is in progress or after you have entered
wrap-up mode.
 
Chat correspondence that is added to an incident is read-only and cannot be edited.
 

Add to Incident
 

Click to add the chat correspondence to an existing incident.
 
Chat correspondence that is added to an incident is read-only and cannot be edited.
 

New Opportunity
 

Click to create an opportunity from the chat session while the chat is in progress or after you have
entered wrap-up mode.
 

Oer Advisor
 

Click to present an oer to the customer.
 
Oer Advisor must be enabled. Contact your Oracle account manager.
 

Related Topics
• Overview of Opportunities

• Overview of Oer Advisor

• Monitor a Chat Session

• Conference Another Agent into Your Chat

• Transfer a Chat to Another Agent

• Wrap Up and Terminate a Chat Session

• Add an Incident

Chat Session Workspace Tabs  
Below the customer’s contact elds is a tab set containing information about the chat session and the customer’s
existing incidents.

• Engagement—The Engagement tab is where you chat with customers.

◦ The Transcript section contains all chat correspondence between you and the customer. As text is sent
from the customer, it appears in the Transcript section with a time stamp. After you send text to the
customer from the Compose section, it is added to the Transcript section with a time stamp.

◦ The Compose section is where you respond to a customer during a chat session. You can use
SmartAssistant to request answers from the knowledge base, manually search for answers in the
knowledge base, and send predened text and URLs to the customer.

• Incidents—The Incidents tab is where you view incident that the customer has submied prior to requesting
the chat.
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• Page Peek—The Page Peek tab is where you view a snapshot of the web page that the customer was viewing
when the chat was initiated.

• Visitor Browser History—The Visitor Browser History tab is where you view a list of up to fteen URLs tracking
the pages of your organization’s website that the customer was viewing prior to initiating the chat. The amount
of time browser history is retained is congured using the VS_PURGE_NON_PAGELOAD_EVENT_DAYS
conguration seing (Agedatabase/Batch Processing/Visitor Service).

Note:  Engagement Engine must be enabled in order to congure and use page peek and visitor browser
history. Contact your Oracle account manager. We recommend creating a custom chat workspace and
removing these tabs if you are not using page peek or visitor browser history.

Related Topics
• Agent Chat Tools

• Chat with a Customer

Chat with a Customer  
If you are the agent selected for a chat request, you will receive a toast notication.

Through chat notication seings, you can also enable sound notication.

By default, the toast notication contains customer information, including the customer’s rst and last names, email
address, and any incident custom elds that have been congured by your administrator.

1. Click Accept on the toast invitation to accept the chat request and activate the chat session.
An automatic greeting is sent to the customer and displays in the Transcript section.

Note:  By default, you have fteen seconds to manually accept or decline an incoming chat request.
After fteen seconds, the toast notication closes and the chat request is returned to the chat queue
from which it originated.
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The customer tab is gray until the customer asks a question. After the customer asks a question, the customer
tab turns green to notify you that it is your turn to respond. By default, the customer tab will change from green
to yellow when a customer has been waiting for a response for thirty seconds. When the tab changes to red, it
signies that a customer has been waiting for sixty seconds. After you respond to the customer, the tab color
changes back to gray. The timing of the changes in tab color can be congured by your administrator.

Note:  If Sneak Preview is enabled, you see the customer’s entry in italics as it is being typed, leing
you begin composing a response. After the customer sends the message, the customer’s message
changes from italicized to regular font. It is a best practice to wait to respond until the customer has
sent the message. If you have multiple active chats, you will only see Sneak Preview for the chat in
focus.

2. Additional customer tabs display if you are engaged in multiple chat sessions. To manage the individual chat
sessions, simply click the appropriate tab when the color changes from gray to green.
You can also move between active chat sessions using the Active Chats drop-down menu on the Live Media
bar. The colors of the selections in the drop-down menu correspond to the colors of the customer tabs.

3. Enter your reply in the message text box in the Compose section.
a. By default, Render As is selected when responding to customers. To send XML, HTML, or any other type

of markup language to the customer without the tags being rendered, select Leave As Plain and all of
the markup tags will display in the response to the customer.

b. To copy and paste text, press Ctrl+C and Ctrl+V.
c. To start a new paragraph, press Shift+Enter.
d. As you type, an inline spell checker recognizes misspelled words and marks them with a red zigzag

underline. Right-click the misspelled word to see a list of substitute words from which you can choose.
You can also choose to add words to your spell check dictionary. See Spell Checking.

4. Click Send or press Enter to send your response.
Your response is added to the Transcript section and the customer’s tab color changes back to gray, signifying it
is the customer’s turn to respond.
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Related Topics
• How You Congure the Preliminary Screen Pop

• Service Level Requirements for Chat

• Live Media Bar

• Change Your Chat Options

• Wrap Up and Terminate a Chat Session

Email Address Sharing in Chat  
Email address sharing lets you associate a single email address with multiple contact records.

By default, email address sharing is disabled, but when it is enabled and a contact submits a chat request, the Email
eld on the chat sessions workspace displays a yellow icon with a black exclamation point if a duplicate email address
is detected by the system. Although contact-matching logic is used to determine which contact to associate the chat
session with, you can manually change the contact association by clicking the Contact eld and selecting Change. See
Email Address Sharing.

Agent Chat Tools  
Agent chat tools give you access to customer information, SmartAssistant suggested answers, answers in the Oracle
Service Cloud knowledge base, and standard text.

In addition, you can transfer chats to other agents, conference other agents into your chat sessions, access guided
assistance guides, and cobrowse with customers. Agent chat tools are available only when chaing with customers.

View Incidents Submied by a Customer  
You can tailor your assistance to customers if you know what issues they are experiencing. For example, if a customer
has an open incident in Oracle RightNow Cloud Service (Service), you can view the contents of the incident while
chaing with the customer.

1. While chaing with a customer, click the Incidents tab.

2. Double-click an incident to open it.
See Incident Creation.

3. After reviewing the customer’s current incidents, click the Engagement tab to return to the chat.
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Search for a Contact Record  
You can access additional information about the customer using the Contact Search feature.

If the customer has a contact record in the knowledge base, for example, you can see any organization association and
where the customer is located.

1. Do one of the following:

◦ If a contact record exists, the customer’s name appears in the Contact eld. Click the customer’s name
and select Open to open the contact record. See Overview of Contacts.

◦ If a contact record does not exist for the customer, the Contact eld is blank. Click Search to the right of
the Contact eld to open the Contact Search window. See Record Search Options.

2. After viewing or editing the contact record, click OK to return to the chat session.

Access SmartAssistant Suggested Answers  
While chaing with a customer, you can use SmartAssistant to suggest answers for a customer’s question.

SmartAssistant searches the knowledge base and returns possible answers related to the chat history text. A new
window opens containing links to the suggested answers. If an answer is pertinent, you can add the answer text or the
answer link to the Compose section and send it to the customer.

1. Click SmartAssistant on the Compose section.
The SmartAssistant window opens.

2. To add the answer link to your response, click Add as Link.
3. To add the answer text to your response, click Add as Text.
4. Click Close.

How You Search the Knowledge Base  
As you respond to a customer’s question, you might remember answers that address similar issues. Rather than
conducting a time-consuming hunt of the knowledge base to nd the relevant answers, Service lets you search for
specic answers.

Using any of four text searching techniques, you can quickly identify answers to resolve a customer’s question. See
Append Answer Content.

Insert Standard Text  
Frequently used responses and URLs can be prepared in advance so that you can quickly send them to customers.

This tool not only helps you assist customers more quickly, but also eliminates typographical errors. Your administrator
can also dene shortcut IDs for standard responses and URLs. Then, you can enter an ID in the Shortcut eld and press
Enter to automatically insert the response or URL in the message text box in the Compose section.

1. Click Standard Text on the Compose section.
The Standard Text window opens.

2. Do one of the following:

◦ Double-click a standard text item to automatically insert it into the Compose section of the response.

◦ Click a standard text item to add it to the Preview section of the Standard Text window and click OK.

◦ Drag the standard text item from the left column into the Compose section of the response.

◦ Copy the text in the Preview section and paste it into the response.
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To search for standard text, click Find in List above the left column. If an HTML version of the standard text
item is available, it displays by default in the Preview section of the window. Otherwise, the plain text version
displays.

Tip:  If you know the shortcut ID, from the Compose section of the response, you can press F8, enter
the keyboard shortcut, and click Enter. The standard text is inserted into the response.

The standard text is now ready to send to the customer.

Note:  If your organization uses variables in standard text, such as contacts.rst_name, you can type
(or copy and paste) the variable inline when responding to a customer. The variable is then replaced
with the appropriate data before you send your response to the customer. If a variable entry does
not have a value associated with it, you must enter the value before sending your response to the
customer.

3. Click OK.

Transfer a Chat to Another Agent  
When necessary, you can transfer a chat to another agent during a chat session. This feature is helpful when another
agent has more experience with a specic topic than you do.

1. At any point during your chat session, click Transfer.
The Select Names window opens.

Note:  Select Transfer to Queue if you are not aware of a specic agent who can accept the transfer.
Chat will then route the chat to an agent in the queue.

2. When you see the agent you want to transfer the chat to, select the agent’s name and click Request.
The agent receives a toast notication to accept, view, or decline the transfer request.

◦ If the agent clicks View, the toast invitation closes, the chat transcript appears on both of your
workspaces, the Compose section indicates In Transfer Consultation, and a message area is highlighted
in blue for private messaging. You and the agent can chat before the other agent accepts or declines the
transfer request. The customer cannot view messages sent in the private message area.

◦ If the agent clicks Accept, the associated contact and incident are automatically saved, and the chat is
transferred to the agent. After the transfer is made, the customer is notied that you left the chat and the
new agent’s name appears in the chat transcript instead of your name.

◦ If the agent declines the conference, the chat stays with you.

Related Topics
• Conference Another Agent into Your Chat
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Conference Another Agent into Your Chat  
Agent conferencing is another way Service helps you provide superior service to your customers.

Conferencing can be useful when you want to include another agent in your chat session to help you solve a customer’s
problem.

1. At any point during your chat session, click Conference.
The Select Names window opens.

2. When you see the agent you want to conference into the chat, select the agent’s name and click Request.
The agent receives a toast notication to accept, view or decline the conference request.

◦ If the agent clicks View, the chat transcript appears on both of your workspaces, the Compose section
indicates In Conference Consultation, and a message area is highlighted in blue for private messaging.
You and the agent can chat before the other agent accepts or declines the conference request. The
customer cannot view messages sent in the blue private message area.

◦ If the agent clicks Accept, the new agent is conferenced into the chat session. The chat transcript appears
on both of your workspaces. After the conference starts, you and the customer are notied. Each person
can send text and all those in the conference can see the message text and the name of the person who
sent it. The Leave buon is disabled on your ribbon because you initiated the conference. The agent you
conferenced in must click Leave to exit the conference.

◦ If the agent clicks Decline, the chat stays with you.

Related Topics
• Transfer a Chat to Another Agent

Access Guided Assistance During a Chat Session  
The Guided Assistance control can be added to custom chat sessions workspaces so guides are available when you chat
with customers.

At any point during a chat session, you can search for a guide or select a guide to resolve dicult questions.

Note:  Guided assistance must be enabled before you can access guides on the chat sessions workspace.
Contact your Oracle account manager.

1. While chaing with a customer, click Search for a Guide or Select a Guide on the Guided Assistance control.
The Search for a Guide or the Select a Guide window opens.

2. To insert a question into the guide, click Add to Chat.
Add to Chat is available for all questions and text explanations in guides.

◦ If the Leave as Plain Text option is selected, all HTML tags and other code that is entered in the reply
(including the code in guides) will display as unrendered.
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◦ The Include Choices check box controls how chat message text is formed from questions when you click
Add to Chat. When the Include Choices check box is selected, the chat message text that is added to the
Compose section includes both the question and its choices. When it is not selected, it includes only the
question.

◦ The Automatically Send check box controls what happens to the chat message text when you click Add to
Chat. When this check box is selected, the chat message text is automatically sent to the customer. When
it is not selected, it is added to the Compose section of the chat and is not sent to the customer until you
click Send.

Related Topics
• Find Answers Using Guided Assistance

Cobrowse with a Customer  
With Cobrowse, you can guide a customer through a web page using your mouse or other pointing device to
demonstrate actions.

In eect, you take control of the customer’s web browser to show the customer how to complete an action. Cobrowse
helps eliminate the confusion that can arise when giving instructions to customers through dialog or text. Cobrowse is
also eective for assisting customers in lling out forms or completing a sale.

Note:  Cobrowse must be enabled before you can begin a session with a customer. In addition, you can
engage in only one cobrowse session at a time.

1. While chaing with a customer, click Screen Sharing.
A message informs you that an invitation is being sent to the customer to start a cobrowse session.
After the customer accepts the cobrowse request, the chat transcript is updated with a link so you can view the
customer’s desktop. Cobrowse is also available for customers using mobile devices.

2. Click the link to view the customer’s desktop.
Focus shifts from the Engagement tab to the Cobrowse tab, where the customer’s desktop displays.
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The cobrowse toolbar lets you control the cobrowse session. Your viewing and cobrowsing options are limited
depending on how your company has set up the Cobrowse deployment. Privacy seings can dier when you
cobrowse in Instant Cobrowse mode or Advanced Cobrowse mode. Your company’s Cobrowse administrator
congures the privacy seings.

Buon/Field Description

Mode Click this drop-down menu to select a cobrowse state, which species how much control
you have over the customer’s desktop.

View Only Select to view the customer’s active window. This option is selected by default in
Advanced Cobrowse mode.

View + Pointer Select to view the customer’s active window and use a labeled mouse as a pointing
device on the customer’s screen.
With this option selected, mouse-click functionality does not work on the customer’s
active window. This option is selected by default in Instant Cobrowse mode.
 

View + True Pointer Select to view the customer’s active window and control the movement of the
customer’s mouse or other pointing device.
This option is only available when cobrowsing in Advanced Cobrowse mode. With this
option selected, mouse-click functionality does not work on the customer’s desktop.
 

Full Control Select to view the customer’s active window, control all mouse or other pointing device
functions (pointer and mouse clicks), navigate to other company web pages, and use
your keyboard to enter information on the customer’s active window (for instance, to
help the customer ll out a form). The customer receives a consent message to allow
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Buon/Field Description

or deny full control, and you’ll see a message when the customer has consented to full
control.
In Advanced Cobrowse mode, you can access the customer’s desktop and cobrowse
third party sites.
 

Advanced Mode Select to escalate to the Advanced Cobrowse mode. An invitation is sent to the customer
to activate Advanced Cobrowse mode.

Client Info Displays the customer’s environment information for operating system, browser version,
 client version, and escalation mode.

Disconnect Click to end the cobrowse session.

Connection Quality Information Displays the strength of the connection in a bar graph.

Zoom In Click to zoom in on the customer’s desktop.
This buon is available only in Advanced Cobrowse mode.
 

Zoom Out Click to zoom out on the customer’s desktop.
This buon is available only in Advanced Cobrowse mode.
 

3. Click Disconnect to disconnect from the cobrowse session.
Both you and the customer are notied when the cobrowse session has ended. The customer can also
disconnect from the cobrowse session at any time.

Note:  Although cobrowse information is not recorded to the chat transcript, it is recorded to
the knowledge base and can be viewed using standard cobrowse reports. See Cobrowse Session
Reporting.

Related Topics
• Congure Cobrowse on a Chat Workspace

Wrap Up and Terminate a Chat Session  
Either you or the customer can end the chat session. If the customer ends the session, a message asks if you want to
terminate or wrap up the session. Alternatively, you can click the Wrap-up or Terminate buons to end the session.

By default, an incident is created when a chat session begins and an Incident eld displays as a key eld containing the
incident’s reference number. You can edit the incident while chaing with a customer by right-clicking the reference
number and selecting Open.

Your administrator can congure chat to create an incident when you terminate or wrap up a chat automatically, or by
prompting you to save the chat as an incident for tracking and reporting purposes. If you choose to create an incident,
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it is assigned to you with a status and status type set by your administrator. The dialog from the chat session is inserted
as a response thread.

1. To enter wrap-up mode, click Wrap-up.
a. Complete any post-chat tasks such as creating an incident, adding the chat to an existing incident,

or creating an opportunity from the chat. You can edit this incident in the same manner as any other
incident, including changing the incident subject.

When you create an incident, the chat transcript is inserted as a response thread on the Messages tab.
The party that initially disconnected from the chat (customer or agent) is also identied in the response
thread. In the event the chat transcript is converted to an incident and emailed to the customer, private
chat messages that took place between you and other agents during the chat are hidden to prevent
customers from seeing them.

b. Click Terminate.
2. To end the session without entering wrap-up mode, click Terminate.

The chat session closes and the chat transcript is inserted as a response thread on the Messages tab of the incident.

Related Topics
• How You Edit Incidents

• Add an Incident

Chat for Supervisors  
Through real-time reporting, Chat makes it easy to manage a group of agents. It is important to familiarize yourself with
the Chat Supervisor Home–Real Time dashboard before monitoring agents.

If you think it is necessary to intervene in a chat session, you can do so at any time by joining the chat and monitoring it.

The following reports display on the Chat Supervisor Home–Real Time dashboard. The Chat Supervisor Home–Real
Time dashboard refreshes every fteen seconds or less, depending on server load.

• Current Chat Queue Statistics—Shows the service statistics for each chat queue.

• Current Chat Agent Statistics—Shows the service statistics for each chat agent.

• Chat Supervisor Queue Snapshot—Shows all current chat engagements, which includes customers who are
waiting to chat with agents. You can view all agents and their active chat sessions, the number of customers
waiting to chat, the average wait time, and the average time duration of chats. See Monitor a Chat Session.

Related Topics
• Chat Sessions Workspace

• Chat for Agents

• Chat for Customers

Monitor a Chat Session  
If you notice a chat duration that is unusually long, you can monitor the chat to see if there are any problems. By making
sure chats ow through the system without interruption, you increase customer satisfaction.
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When you monitor a chat session, the chat automatically opens on the Engagement tab. The look and feel of the
Engagement tab is the same for both supervisors and agents.

Tip:  When monitoring a chat, you might want to disable auto scrolling on the chat sessions workspace so
the Transcript window does not automatically scroll to the newest thread every time an agent or customer
updates the chat session. For information about the Auto Scroll Control Position property, see Selected Object
Properties.

1. Click Login Chat to log in to Chat.
2. From the Chat Supervisor Queue Snapshot report, right-click the chat you want to monitor.

The chat session opens on the Engagements tab and you can view all correspondence between the agent and
customer. At this point, the agent does not know the chat is being monitored.

3. To join the chat you are monitoring, click Join.
The Compose section is activated and the agent is notied that you joined the chat.

4. To send a message to the agent, enter your message in the Compose section.
The Private check box is selected by default to ensure that the customer does not see your message to the
agent and does not know you are monitoring the chat. If you want the customer to see your message to the
agent and to be notied that you are participating in the chat session, clear the Private check box.

5. Click Send to send your message to the agent.
6. To leave the chat you are monitoring, click Leave.

You are disconnected from the chat and the monitoring session ends. The agent is notied that you left the
chat. If you cleared the Private check box during the monitoring session, the customer is also notied that you
left the chat.

Related Topics
• Chat Sessions Workspace

Chat for Customers  
The Chat page is the customer interface where customers chat with agents.

Because the Chat page is integrated with the customer portal, it can be customized to suit your customers’ needs.

After customers submit a chat from the Live Help page on the customer portal, the Chat page opens. This page displays
a wait time and queue position when customers are waiting to chat. In addition, customers can search the knowledge
base for answers to their questions while they are waiting to chat with an agent.

This image shows the Chat page after an agent accepts a customer’s request to chat. What your customers see may be
dierent if your administrator has customized this page.
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Buon Description

 Mute Customers click to mute incoming sound notications.

 Print Customers click to print the chat correspondence at any time.

 Send an O the Record Message Customers click to send unrecorded messages during the chat session.
This buon appears only during a chat session. Agents cannot send unrecorded messages
to customers. If the chat session is saved as an incident, the unrecorded message displays as
“<username>: Message Removed.”
 

Disconnect Customers click to disconnect from the chat session.
This buon appears only during a chat session.
 

Close Customers click to close the Chat page.
This buon appears only after a chat session is disconnected.
 

Aach File Customers click to send le aachments during the chat session.
This buon appears only during a chat session.
 

Send Customers click to send messages to an agent.
This buon appears only during a chat session. Customers can also press Enter to send messages.
 

Related Topics
• Chat Customer Reconnect

• Chat for Agents

• Chat for Supervisors

• Chat with an Agent

Chat with an Agent  
Customers chat with an agent from the Live Help page.

1. From the Live Help page, the customer lls in the required information and clicks Submit Request.
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The Chat page opens. While Chat searches for an available agent, the customer is placed in the wait queue and
is provided with the estimated wait time and position in the queue.

After an agent accepts the chat request, the status section changes from Searching to Connected, and the Chat
Dialog section opens with a greeting from the agent.

2. The customer enters a question and presses Enter or clicks Send.
The customer’s question is added to the Chat Dialog section.

3. The agent responds to the customer.
The agent’s response is added to the Chat Dialog section.

4. After receiving an answer to the question, the customer clicks Disconnect to terminate the chat session.
The agent is notied that the customer has disconnected.

5. The customer clicks Close to close the Chat page and return to the Live Help page.

Chat Customer Reconnect  
In the case of a crashed browser or otherwise improperly terminated chat session, the chat reconnect feature lets
customers reconnect to their previous chat session.

When customers are unintentionally disconnected from a chat and aempt to chat again, they receive a message
stating that an existing chat session was found and are given the option of resuming that session. Upon reconnecting
to the chat session, the Chat page is populated with all chat correspondence that was present before the chat became
disconnected, and customers can resume the chat session where they left o without having to wait in a chat queue.
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9  Cobrowse

Overview of Cobrowse  
Cobrowsing lets customers share their desktop with agents who are helping them on the telephone or during a chat
session.

Sta members can guide customers through web pages using their mouse or other pointing device to demonstrate
actions. In eect, they take control of the customer’s browser to show the customer how to complete an action.
Cobrowse helps eliminate the confusion that can arise when giving instructions to customers through dialog or text.
Cobrowse is also eective for assisting customers in lling out forms or completing a sale.

Administrators use the administrative console to manage the product and customize the Cobrowse user interface. See
Admin Console. See Answer ID 5673 on our support site for system requirements.

Related Topics

Admin Console  
The Cobrowse administrative console is a standalone user interface used to manage the Oracle Cobrowse product, to
customize the user interface and congure its deployment, add and edit users, and access additional Cobrowse reports.

With Oracle Service Cloud, you congure Cobrowse on chat and incident workspaces, add a Cobrowse widget to the
customer portal, and give Cobrowse permission to agents working on the agent desktop through their prole.

In addition, the following functionality is available for Conguration Administrators through the Cobrowse Admin
Console:

• Company set up and remote control options (see Working with Companies)

• User management and permissions (see Managing Permissions and Managing Users)

• SiteID management (see Managing SiteIDs)

• Cobrowse product UI customization, security masking, and deployment (see Conguring the Cobrowse UI,
Creating Conguration Files for Privacy and Security, and Conguring Your Company Deployment)

• Reporting (see Working with Reports)

See Implementing Standalone Cobrowse for more details on working with the Admin Console.

Congure Cobrowse on an Incident Workspace  
Cobrowse conguration for incident workspaces consists of creating a custom incident workspace with a tab where
agents can cobrowse with customers.

1425

http://cx.rightnow.com/app/answers/detail/a_id/5673
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/working-with-companies.html#working-with-companies
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/permissions.html#c_Managing_permissions_ac1196729
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/managing-users.html#managing-users
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/managing-siteids.html#managing-siteids
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/configuring-the-cobrowse-ui.html#configuring-the-cobrowse-ui
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/creating-configuration-files-for-privacy-and-security.html#creating-configuration-files-for-privacy-and-security
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/configuring-your-company-deployment.html#configuring-your-company-deployment
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/working-with-reports.html#working-with-reports
https://docs.oracle.com/en/cloud/saas/b2c-service/19d/fascg/index.html


Oracle Service Cloud
Using Service Cloud

Chapter 9
Cobrowse

You must add the CobrowsePremium widget to the customer portal before agents can cobrowse with customers. See
Add the CoBrowsePremium Widget.

Note:  Before you can congure Cobrowse, it must be enabled. To enable Cobrowse, contact your Oracle
account manager.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces.

The Workspaces explorer displays on the content pane.
3. Expand the Standard folder, right-click the incident workspace, and select Copy.

The Copy Incident As window opens.
4. Enter a name for the copied workspace in the Name eld and click OK.
5. Open the copy of the incident workspace.
6. Right-click next to the Audit Log tab and select Add Tab.
7. Click the Design tab.
8. In the Label section of the ribbon, click the Text drop-down menu and rename the tab Cobrowse.
9. Click the Insert Control tab.

10. In the Relationship Items section, drag the Co-browse control into the Cobrowse tab on the workspace.
11. Click Save.

Now you need to assign this custom incident workspace to proles. See Proles. For information about using Cobrowse
on incident workspaces, see Cobrowse with a Customer from an Incident Workspace.

Add the CoBrowsePremium Widget  
Follow this procedure to add the CoBrowsePremium widget to your customer portal pages.

1. Open the standard.php le in the views/templates folder.
2. Locate the following lines of code.

 <div class="rn_Feedback">
 <rn:widget path="feedback/SiteFeedback"/>
 <span>#rn:msg:SITE_USEFUL_MSG#</span>
 </div>
 </rn:condition>
 </div>

3. Add the following lines of code immediately after the last line you located in step 2.
 <div>
 <rn:widget path="utils/CobrowsePremium" />
 </div>

4. Save standard.php.
5. Promote the customer portal pages to Production.

To enable mobile compatibility, follow these same steps to modify the mobile.php template.
After the widgets have been added to the appropriate pages, the standard and mobile page sets need to be enabled.
See Stage Customer Portal Pages and Promote Customer Portal Pages.
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Congure Cobrowse on a Chat Workspace  
Cobrowse conguration for Oracle RightNow Chat Cloud Service consists of creating a custom chat sessions workspace
with a tab where agents can cobrowse with customers.

You must add the ChatCobrowsePremium widget to the customer portal before agents can cobrowse with customers.
See Add the ChatCobrowsePremium Widget. In addition, a Cobrowse control must be added to the workspace ribbon so
sta members can invite customers to cobrowse when they are chaing with them.

Note:  Before you can congure Cobrowse, it must be enabled. To enable Cobrowse, contact your Oracle
account manager.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Workspaces.

The Workspaces explorer displays on the content pane.
3. Expand the Standard folder, right-click the chat sessions workspace, and select Copy.

The Copy Chat Sessions As window opens.
4. Enter a name for the copied workspace in the Name eld and click OK.
5. Open the copy of the chat sessions workspace.
6. Right-click next to the Incidents tab and select Add Tab.
7. Click the Design tab.
8. In the Label section of the ribbon, click the Text drop-down menu and rename the tab Cobrowse.
9. Click the Insert Control tab.

10. In the Relationship Items section of the ribbon, drag the Co-browse control into the Cobrowse tab on the
workspace.

11. Click the Home tab on the ribbon and click Ribbon.
The ribbon designer opens.

12. Click a buon in the Session group to activate the buons.
13. Click Add Buons on the ribbon designer toolbar.

The Add or Remove Buons window opens.

14. Select Screen Sharing and click OK.
The Screen Sharing buon displays on the ribbon designer.

15. Click OK.
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The ribbon designer closes.
16. Click Save.

Now you need to assign this custom chat sessions workspace to proles. See Proles. For information about using
Cobrowse on chat workspaces, see Cobrowse with a Customer.

Add Cobrowse Permissions to a Prole  
Cobrowse is not fully functional until sta members have been assigned cobrowse permissions in their prole.

After you create or edit a prole containing cobrowse permissions, you can then assign the prole to individual sta
members. This lets you designate which sta members have access to Cobrowse. You can assign cobrowse permissions
to one or more proles based on your organization’s needs.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The report opens on the content pane.
3. Double-click the prole you want to edit.

The Prole editor opens.
4. Click Permissions.

The Permissions page opens.
5. Click the Service tab.
6. Select Co-browse.
7. Click Save.

Before agents can use Cobrowse, you must assign a prole containing cobrowse permissions to their sta account. See
Add or Edit a Sta Account.

Cobrowse Session Reporting  
The Co-Browse Summary report displays cobrowse activity from all sources and shows detailed information about each
cobrowse session such as agent and contact names, when the session started and ended, and what caused the session
to end.

With this information, you can spot trends and implement steps to improve customer satisfaction.

The Co-Browse Summary report is available in Public Reports/Service/Co-Browse. Before sta members can use the
report, it must be added to their navigation sets. See Edit a Navigation Set.

All cobrowse data is stored in the cobrowse_sessions table. Although the table is used for the Co-Browse Summary
report, it can also be used for custom reports. See Overview of Creating Basic Custom Reports.
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10  Outreach and Feedback

Explorers  

Overview of Explorers  
Explorers are used to access and manage mailings, campaigns, questions, surveys, audiences, and content library
items created in Oracle RightNow Outreach Cloud Service (Outreach) and Oracle RightNow Feedback Cloud Service
(Feedback).

With these explorers, you can browse, search, and organize items in hierarchical folders on the content pane using
functions similar to Windows Explorer. Like Windows Explorer, each Oracle Service Cloud explorer consists of a set of
hierarchal folders and a detailed list of available items. Explorers display items of their associated type. For instance,
documents are listed in the Documents explorer.

While each explorer generally resides in its associated navigation list, it is important to remember that explorers can be
added to (or removed from) any navigation list, just like a report. For example, the Mailings explorer can be added to
the Mailings navigation list or to a dierent navigation list. If you are unable to locate a specic explorer in any of your
navigation lists, contact your administrator.

The following table describes how to open each Outreach and Feedback explorer from its most common location on the
navigation pane.

Explorer Description

Outreach Explorers
 

These explorers are used to manage mailings and campaigns.
 

Mailings
 

Click Mailings on the navigation pane and double-click Mailings Explorer. See Overview of Mailings.
 

Campaigns
 

Click Campaigns on the navigation pane and double-click Campaigns Explorer. See Overview of
Campaigns.
 

Feedback Explorers
 

These explorers are used to manage questions and surveys in Feedback.
 

Questions
 

Click Questions on the navigation pane and double-click Questions Explorer. See Overview of
Questions.
 

Surveys
 

Click Surveys on the navigation pane and double-click Surveys Explorer. See Overview of Surveys.
 

Audience Explorers
 

These explorers are used to manage audiences in both Outreach and Feedback.
 

Contact Lists
 

Click Audiences on the navigation pane and double-click Contact Lists Explorer. See Add a Contact List.
 

Segments Click Audiences on the navigation pane and double-click Segments Explorer. See Create a Segment.
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Explorer Description

   

Content Library Explorers
 

These explorers are used to manage content library items in both Outreach and Feedback.
 

Documents
 

Click Content Library on the navigation pane and double-click Documents Explorer. See Create a
Document.
 

Tracked Links
 

Click Content Library on the navigation pane and double-click Tracked Links Explorer. See Add a
Tracked Link.
 

File Aachments
 

Click Content Library on the navigation pane and double-click File Aachments Explorer. See Add a
File.
 

Templates
 

Click Content Library on the navigation pane and double-click Templates Explorer. See How Templates
Work.
 

Snippets
 

Click Content Library on the navigation pane and double-click Snippets Explorer. See How Snippets
Work.
 

Find a Document  
Explorers contain a number of search functions to help you nd mailings, campaigns, segments, contact lists,
documents, tracked links, les, templates, snippets, surveys, and questions.

The following procedure describes how to search for a document from the Documents explorer, but the steps are the
same for searching for other Outreach and Feedback items.

Tip:  You can also search for mailings, campaigns, surveys, and documents from anywhere in the product
using Quick Search. See Overview of Quick Search.

1. Click Find on the ribbon.
The left side of the content pane displays a Find menu, hiding the folders tree.

2. Enter eld information.

Field Description

Find Using This drop-down menu contains the names of all the columns in the documents list.
Each column is associated with one of three data types that are supported in explorer
searches.

◦ Strings—Search for strings that start with, contain, end with, or match the value
you enter in the text box.

◦ Dates—Search for dates before, on, or after today’s date. You can also click the
calendar in the search text box to display the current month calendar and select
another day, or click the arrows at the top of the calendar to change months.

◦ Integers—Search for values that are less than, equal to, or greater than a number.
You can also click the up and down arrows in the search text box to increase or
decrease the search value.
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Field Description

Note:  The data type of the column you select determines the available search
criteria. For example, if you select Created (a date data type), you can search
for dates before, on, or after a selected date.

Search text box Type your search text in this eld.
 

Case Sensitive When searching a string column, select this check box to match the case.
 

Show Advanced Options Click this text or the down arrow to display the following advanced search options.
 

Search globally, replace results Select this option to remove the results from the previous search and replace with
results from this search. This method is selected by default.
 

Search within results, replace results Select this option to search only the current results and keep only those that match this
search.
 

Search globally, append to results Select this option to keep results from the previous search and add results from this
search.
 

Return Non-matching Items Select this check box to return all documents that do not match your search criteria.
 

3. Click Find.
The search results replace the document list in the explorer.

4. To clear the value from the search text box, click Clear.
5. To replace the search results with the original documents list, click Refresh on the ribbon.

For additional information about explorer search functionality, see the Search On state in Explorer Display
States.

Edit an Item  
You can edit items used in documents, mailings, and surveys.

1. Select the item you want to edit and click Open.
The item opens on the content pane.

2. Edit the necessary elds and click Save.
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Copy an Item  
You can copy items used in documents, mailings, and surveys.

1. Select the item you want to copy and click Copy.
The Copy As window opens.

2. Select the folder you want to save the item in and enter the name of the item in the Name eld.
3. Click OK.

Delete an Item  
You can delete items used in documents, mailings, and surveys. However, make sure the item has no dependencies
before you delete it.

1. Select the item you want to delete and click Delete.

CAUTION:  If you aempt to delete an item that is being used in a document, mailing, survey, or
campaign, a dependency warning lists each location where the item is used and provides you with
an option to cancel the deletion. If you choose to continue deleting the item, all references to the
item become invalid and you must manually update each reference appropriately. For example, if you
delete a tracked link used in a survey, you must edit the survey and either remove the tracked link or
replace it with a valid link.

Automatically Generated Folders  
The Documents explorer contains a folder for content that is automatically created when a document is saved or copied
in a mailing or survey.

The system creates a copy of each document that is inserted in a mailing message or a survey invitation message,
and each page that is added to the questionnaire in a survey. Each copy is stored in the corresponding subfolder in
the Automatically Generated folder. You can reuse these documents or use them to track the content you have used in
previous mailings or surveys. Additionally, automatically generated copies of each message template can be found in
the Automatically Generated folder. However, the message template documents are read-only.

The Tracked Links explorer also contains an Automatically Generated folder that contains all tracked links that are
created when the tracked link converter runs. See Convert Links to Tracked Links.

Note:  If you modify the content in a mailing or survey, those changes are also made to the automatically
generated copy and impact all other instances of that copy. For example, if you create a mailing and insert an
existing document on the Message tab, a copy of that document is automatically generated and stored in the
Automatically Generated folder. Each time you modify the content in that mailing, the copy is also modied,
but the original document is not modied. However, if you share a document with a mailing or survey, every
time the content is updated, all occurrences of the document are also updated.
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Folder Description

Documents explorer
 

The Documents explorer contains the following automatically generated folders.
 

Mailing Messages
 

This subfolder contains a copy of every document created on the Message tab in a mailing after
the mailing is saved. The new document is named “YYMMDDHHMM <mailing name>” where
YYMMDDHHMM is the year, month, day, hour, and minute of the rst save, and the mailing name
corresponds with the name of the original mailing. If more than one message is used (for example,
 the same document is reused in multiple mailings), the new document is named “YYMMDDHHMM
<mailing name>: <message name>” where “message name” corresponds with the message dened on
the Message tab of the mailing.
 
The document name is limited to 80 characters.
 

Message Templates
 

This subfolder contains a copy of every administrator notication, administrator email, and contact
email for this interface. The documents are named the same as the corresponding message.
 
These documents are read-only.
 

Survey Invitation Messages
 

This subfolder contains a copy of every document created on the Invitation Message tab in a survey.
The new document is named “YYMMDDHHMM <survey name>” where YYMMDDHHMM is the year,
 month, day, hour, and minute of the save, and the survey name corresponds with the name of the
original survey.
 
The document name is limited to 80 characters.
 

Survey Pages
 

A subfolder is created for each survey created in basic mode and is named the same as the
corresponding survey. These folders contain a document for each page in the questionnaire. When you
add, edit, or delete a page in the questionnaire, the corresponding document is also modied.
 
Documents are read-only if they are created in basic mode but can be edited if they are converted to
advanced mode.
 

Survey Reminders
 

This subfolder contains a copy of every document created on the Reminders tab in a survey. The copy
is named “YYMMDDHHMM <reminder name>” where YYMMDDHHMM is the year, month, day, hour,
 and minute of the save, and the name corresponds with the name of the original reminder.
 
The name is limited to 80 characters. You can edit the reminders in this folder as long as they have not
been sent.
 

Tracked Links explorer
 

The Automatically Generated folder in this explorer contains all of the tracked links that are created
every time the tracked link converter runs. The tracked links are organized in subfolders using the
YYYY-MM-DD format, which corresponds to the date the tracked links are generated. See Convert
Links to Tracked Links.
 
You can edit or move the tracked links in this folder.
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Audiences  

Overview of Audiences  
Oracle Service Cloud provides two methods for grouping contacts to create audiences for your broadcast mailings and
surveys: contact lists and segments.

Contact lists are static lists comprised only of contacts that have been explicitly selected, changing only when you
manually add or remove contacts. Segments are dynamic lists comprised of contacts that match one or more xed
lters that you specify. Because segments are dynamic, their contents change over time as updated contacts fall in and
out of alignment with the lters.

When you create a mailing or survey, contact lists and segments can be used alone or included with (or excluded from)
other lists and segments to form your audience. You can include and exclude a total of fty contact lists and segments,
each containing a vast number of contacts. This gives you all the exibility you need to assemble audiences that are
specic, optimized, and eciently maintained.

For information about uploading contacts to your knowledge base, see Add a Contact. For information about adding
segments and lists to mailings and surveys, see Dene the Broadcast Mailing Audience and Dene the Broadcast Survey
Audience.

Related Topics
• Dene the Transactional Mailing Audience

• Dene the Transactional Survey Audience

Add a Contact List  
Contact lists are static sets of contacts you can use to dene audiences for broadcast mailings and surveys.

Contact lists are static in that you add each contact to a list manually. Otherwise, the list does not change, even when a
contact record is modied in the database. Every time a contact list is used, it returns the same set of contacts. You can
create as many lists as you want and update them by manually adding or removing contacts as needed. After a contact
list is created, you can update your audiences to include or exclude it.

Note:  The following procedure assumes that you access the Contact Lists explorer from the Audiences
navigation list. However, this explorer may reside in a dierent navigation list.

1. Click Audiences on the navigation pane.
2. Double-click Contact Lists Explorer.

The Contact Lists explorer opens on the content pane.
3. Click New.

Tip:  You can also create a contact list from an open contact list by clicking New. Additionally, if your
navigation set is congured to add contact lists from the le menu, click  File > Audience > Contact
List . See Overview of Navigation Sets.
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A new contact list opens on the content pane.
4. Enter eld information.

Field Description

Notes Enter any notes associated with the contact list in this eld.
 

Available for Proof Select this check box to let contacts in the list receive proof requests. See Send a Proof.
 

Remove Contacts from Old List Clear this check box to let contacts stay in contact lists for longer than the time frame
set in the database. When this check box is selected, contact list data is removed
according to the value of a database variable that is set, by default, to 400 days. To
change this value, submit a service request on our  support site . Also see  Answer ID
4802 .
 

Tip:  We recommend leaving this check box selected to ensure your database
tables stay at a manageable size.

Count This eld displays the number of contacts in the contact list the last time it was counted
and the date and time the count was performed.
 

Details
 

To view the details of a count, click Details in the Current Count section after the count
has been performed. A window opens showing the number of contacts belonging to the
contact list, and how many of those contacts have an invalid or duplicate email address
or no address.
 
A count must be performed before Details are available.
 

Refresh
 

To calculate the number of contacts currently in the list, click Refresh.
 
The list must be saved before the count is refreshed.
 

5. To add new and existing contacts to the list on the Contacts tab, see How Contact Lists Work.
6. To view a list of actions taken on the contact list, click the Audit Log tab.
7. To check the spelling of any elds that have spell checking enabled, click Spelling.
8. Click Save.

The Save As window opens.
9. Select the folder you want to save the contact list in and tnter the name of the contact list in the Name eld.

10. Click Save.

How Contact Lists Work  
From the Contacts tab of the contact list editor, you can add existing contacts to the list or create new contacts and add
them to the list.
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You can search your list of contacts, remove contacts from the list, or edit contact records. See Overview of Contacts.
Contacts can also be added to lists in large batches using the Data Import Wizard. See How Data Import Works.

Note:  Keep in mind that in some cases your contact list may time out before it can show your results. When
this happens, a message displays on the Contacts tab of the contact list editor where you have the option to
queue your results and then view them in a report. Alternatively, you can rene your search criteria to return
less data. See Overview of Queuing Reports, How You View Reports in the Queue, and Search for Records in a
Report.

Add a Contact to the Contact List  
You can add existing contacts to your contact list from the Contacts tab of the contact list editor.

1. On the Contacts tab of a contact list, click  Add > Add Existing .
The Contact Search window opens.

2. To search for an existing contact to add to your contact list, enter the search criteria in one or more elds.
You can use any of the following elds to dene your search criteria.

◦ Contact Last Name

◦ Contact First Name

◦ Phone

◦ Email

◦ Postal Code

◦ Organization

◦ CX State

Tip:  You can use an asterisk (*) as a wildcard in your search term.

3. Click Search.
A list of contacts that match the search criteria you entered appears in the grid below the search criteria elds.

4. Select a contact and click Select to add the contact to the list.

Tip:  You can select multiple contacts by pressing Ctrl while clicking additional contacts. Selected
contacts that are already in the list are not added again.

The contact appears on the Contacts tab with the other contacts in the contact list.
5. To add a new contact, click  Add > Add New . See Create a Contact and Add It to the Contact List.
6. Click Save.

Create a Contact and Add It to the Contact List  
You can create new contacts and add them to your contact list.

1. On the Contacts tab of a contact list, click  Add > Add New .
The New Contact window opens.

2. Enter contact eld information.
Names of required elds appear in red text and are agged with asterisks.

3. Click OK.
The contact appears on the Contacts tab with the other contacts in the contact list.
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Note:  Clicking OK on the child window saves the new contact in memory but it is not added to the
knowledge base until you save the contact list (the item from which the contact record was created).
See Overview of Contacts.

4. Click Save.

Search the Contact List  
You can search the list of contacts using several elds and return the results in the grid. Contacts can then be removed
from the contact list or a contact record can be edited.

1. From an open contact list, click Search List on the Contacts tab toolbar.
The Search window opens.

2. In the Filters section, enter the last name, rst name, or email address of the contact you are searching for.
Partial values can be used.

3. In the Limit and Order section, enter the maximum number of contact records you want to return.
a. To return all matching contact records, but limit the number of contact records per page, select the Per

Page check box.
4. To sort by elds other than last name followed by rst name, click the Order By text and select from the

available elds.
5. To design your Search window layout and to set, restore, or reset your default lter values, click the Seings

drop-down menu. See Modify the Search Window.
6. Click Search.

Search results are returned on the Contacts tab.
7. To edit a contact record, click Open next to the contact.
8. To remove a contact from the contact list, click Remove next to the contact.

Note:  This does not delete the contact from the knowledge base. It only removes the contact from the
list.

9. To remove all contacts from the contact list, click Clear List.
a. Click Yes to conrm.

10. To clear the search results and view the entire contact list, click View Entire List.
11. To refresh the contact list, click Refresh.
12. To access report options, such as sorting and exporting, click Options next to the contact. See How You

Distribute Reports and Dashboards and How You Change Report Formaing.

Create a Segment  
While contact lists are created by manually adding contacts to a static list, segments are dynamic lists of contacts
created by dening contact criteria and selecting lters.

When you create a segment, you can lter using any eld in the Contacts (contacts) table, including custom elds,
and by joining the Contacts table to other tables. For example, some segments might include all contacts who live in
Montana, all contacts between the ages of 18 and 24, or all contacts who live in Montana and are between the ages of 18
and 24. You can also lter contacts by whether they have submied an incident related to a certain product.

After you create a segment, it can be used in mailings and surveys and the group of contacts is constantly adjusted
and updated as contact data meets or falls outside of the segment requirements. For example, a segment that selects
customers based on their age produces a dierent result every time it is used for a mailing, assuming that customer
contact data changes.
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Note:  The following procedure assumes that you access the Segments explorer from the Audiences
navigation list. However, this explorer may reside in a dierent navigation list.

1. Click Audiences on the navigation pane.
2. Double-click Segments Explorer.

The Segments explorer opens on the content pane.
3. Click New on the ribbon.

Tip:  You can also create a segment from an open segment by clicking New. Additionally, if your
navigation set is congured to add segments from the le menu, click  File > Audience > Segment .
See Congure the File Menu.

a. To create a segment from scratch, click New Segment.
The Segment editor opens on the content pane.
The content pane is divided into sections to group common functions and help make creating the
segment easier. At the top is the current count of contacts meeting the segment criteria. The tabs let you
dene the segment lters and data set, preview a list of contacts belonging to the segment, and view the
audit log.

b. To create a segment by copying an existing segment, click Choose Existing Segment.
The Choose Existing Segment window opens where you can select the segment you want to use.

c. To import an XML segment, click Import Segment.
4. Enter eld information to dene the segment lters on the Criteria tab.
5. To preview the contacts belonging to the segment, click the Preview tab.
6. To refresh the audience count, click Refresh in the Count section.
7. To view the details of an audience count, click Details in the Count section after the count has been performed.

A window opens showing you the number of contacts belonging to the segment, along with how many of those
contacts have an invalid or duplicate email address or no address.

8. To view a list of actions taken on the segment, click the Audit Log tab.
9. Click Save.

The Save As window opens.
10. Select the folder you want to save the segment in and enter the name of the segment in the Name eld.
11. Click Save.

How Segment Filters Work  
Filters determine which contacts are returned when the segment is applied to contact data.

You can use expressions and operators to determine a data set, and you can also use SQL-type functions (such as
aggregate, string, date, logical, and math functions) to dene expressions when creating a lter. From the Criteria tab of
the Segment editor, you can dene the lters used by your segment and the database tables used to create the lters.

The Data Dictionary section lists the database tables that can be accessed by the segment. You can also join tables to
columns in other tables, such joining the Contacts (contacts) table to the Incidents (incidents) table.

The Fields section shows the elds (database columns) associated with the table selected in the Data Dictionary section.
You can drag and drop elds from the Fields section to the Filters section to lter contacts by that eld. For example,
you could select the Contacts table in the Data Dictionary section and drag and drop the State/Province eld from the
Fields section to the Filters section to lter contacts by the state in their address. For a description of the available tables
and columns, see the Overview of the Data Dictionary.
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In addition to drag-and-drop functionality, you can click Add Filter in the Actions section to add a lter. After lters are
added, you have additional options in the Actions section to edit and delete lters and change the logical expression
used for multiple lters.

Related Topics
• Functions for Segments

• Filter Operators for Segments

Add Filters to a Segment  
Filters determine which contacts are returned when the segment is applied to contact data.

1. Select a table in the Data Dictionary section.
The table columns appear in the Fields section.

2. Drag and drop a column name from the Fields section to the center of the Criteria tab.

Tip:  You can also add a lter by clicking Add Filter in the Actions section or double-clicking a column
name in the Fields section.

The Edit Filter window opens.

3. Enter the name of the lter in the Name eld.
The name appears in the Filters section of the Criteria tab.

4. Enter eld information.

Field Description

*Expression Enter the expression you want to use to limit the data set in this eld. The syntax is
<table_name>.<column_name>. As you type an entry in the Expression eld, a drop-
down menu displays a list of database tables that begin with the leers you type. You
can enter the complete expression or select a table and eld from the drop-down menu.
You can also select a table and column or function by right-clicking in the eld.
 

Tip:  If you drag and drop a column name from the Fields section, the eld
contains the table and column name.

Operator Select the operator to use in comparing the expression to the value. The available
operators vary depending on the expression.

Value Type Select the type of value to match with the expression from these options.

Constant Select this option to type the value to complete the lter or select the value from a drop-
down menu or calendar (depending on the expression).

Expression Select this option to enter an expression to complete the lter, using the syntax <table_
name>.<column_name>.

Value Enter the value that the expression is compared to. The available options in the Value
eld change depending on the type of eld, the operator you select, and the value type.
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Field Description

For example, when the eld type is menu, you select it from a drop-down menu, but
when the eld type is date, you select if from a calendar.

5. To customize the list of values that display in the Value eld, click Customize.
The Customize link is available only when you select equal or list values from the Operator drop-down menu
and when the Value eld displays as a drop-down menu.

6. To select an expression or expression value from a list of database elds and functions, click Use Data
Dictionary. The Edit Expression window opens.

a. Enter the expression by dragging and dropping columns and functions from the Available Columns/
Functions section to the Expression section.

Expression Description

Current Dataset
 

Select a table and column from the tables currently used in the segment. The
Contacts table is available by default.
 

All Tables
 

Select a table and column from the available tables.
 

Functions
 

Select a function to lter contacts in the segment.
 

b. Click OK to save the expression and return to the Edit Filter window.
7. Click OK to save the lter.

Note:  If there is an error in the expression, the Expression eld changes to orange and an error
exclamation point appears. Hover over the exclamation point for more information about the error.
You must either correct the error or click Cancel to exit the window.

8. To edit a lter, do one of the following:
◦ Select the lter and click Edit Filter in the Actions section.

◦ Right-click the lter in the Filters section and select Edit Filter.

9. To display the lter expression in the Filters section instead of the name you dened, click Display Filter
Descriptions. To switch back to the lter name, click Display Filter Names.

10. To delete a lter, do one of the following:
◦ Select the lter and click Delete Filter in the Actions section.

◦ Right-click the lter in the Filters section and select Delete Filter.

11. To dene the logical expression used when multiple lters are included in the segment, see Edit a Logical
Expression.

12. To dene the tables and joins used in the segment, click Edit Data Set in the Advanced Options section. See
Edit the Data Set.

13. To apply group lters to the segment, click Edit Group Filters in the Advanced Options section. See Create a
Group Filter.

Functions for Segments  
Functions let you apply standard mathematical operators to your segment. You can also combine dierent functions
and database elds in an expression.
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Before you begin—Before you can add a function, you must add a lter. See Add Filters to a Segment.

After you drag a function to the expression on the Edit Expression window, you must enter the variables used in the
function. You can either type the variables in the Expression eld or, if the variable is an item listed in the Available
Columns/Functions eld, you can drag the item into the function of the expression.

Expression Description

Aggregate Functions Select from the following to use an aggregate function in the expression.
Aggregate functions are available only when dening group lters. See Create a Group Filter.
 

avg(expr)
 

This function computes an average value for the data set expr.
 

count(expr)
 

This function returns the number of rows included in the data set expr.
 

rst(expr, sort column1[, sort column2][,
...])
 

This function returns the rst value in the data set expr based on the order of the specied
sort columns. For example, the expression first(threads.note, threads.entered,
 threads.seq) returns the rst thread note in the data set based on time entered and thread
sequence.
 

group_concat(expr, separator[, sort
column 1, ASC|DESC][, sort column 2, ASC|
DESC][,...])
 

This function lets you combine multiple values from data set expr into a delimited list in a single
row. The list is delimited by separator and ordered by the specied sort columns. For example, the
expression group_concat(threads.note, ',', threads.entered, ASC) returns a comma-
delimited list of thread notes ordered by time entered ascending.
 

last(expr, sort column1[, sort column2][,...])
 

This function returns the last value in the data set expr based on the order of the specied sort
columns. For example, the expression last(threads.note, threads.entered, threads.seq)
returns the last thread note in the data set based on time entered and thread sequence.
 

max(expr)
 

This function returns the largest numerical value, the last string in alphabetical order, or the latest date
in the data set expr.
 

min(expr)
 

This function returns the smallest numerical value, the rst string in alphabetical order, or the earliest
date in the data set expr.
 

sum(expr)
 

This function returns the sum of the values in the data set expr.
 

sum_distinct(expr, reference)
 

This function returns the sum of distinct values in an expression for a particular record (reference)
rather than for all records of the same type in a table. For example, if you want to calculate the
sum of all quotas for a particular sales person, you could add a function of sum_distinct(sa_
period2accts.quota, sa_period2accts.acct_id).
 

stddev(expr)
 

This function returns the standard deviation of expr. For example, the expression
stddev(answers.solved_count) returns the standard deviation of all the values in the solved_
count column of the Answers (answers) table.
 

String Functions Select from the following to use a string function in the expression.

concat(str1,str2)
 

This function combines input character strings from multiple expressions into a single output
string. Two or more expressions can be appended with this function. For example, the expression
concat('www.','global','.com') returns the value www.global.com.
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Expression Description

 

instr(str, substr)
 

This function returns the numeric position (in characters) of the initial occurrence of string substr
within string str. For example, the expression instr('globalcellphones.com','cell') returns
the value 7.
 

length(str)
 

This function returns the length (in characters) of the string. For example, the expression
length('cell phones') returns the value 10.
 

lower(str)
 

This function returns string str in all lowercase characters. For example, the expression
lower('Global.COM') returns the value global.com.
 

ltrim(str)
 

This function returns the string str without leading spaces. For example, the expression ltrim('
Cell phone') returns the value Cell phone.
 

lpad(str1, X, str2)
 

This function returns str1 padded on the left with str2 until str1 is X characters long. For example, the
expression lpad('phone', 10, '@') returns the value @@@@@phone.
 

rpad(str1, X, str2)
 

This function returns str1 padded on the right with str2 until str1 is X characters long. For example, the
expression rpad('phone', 10, '@') returns the value phone@@@@@.
 

rtrim(str)
 

This function returns the string str without trailing spaces. For example, the expression
rtrim('agarfield@global.com ') returns the value agarfield@global.com.
 

substr(str, start_pos, [length])
 

This function returns a portion of the string str starting at the character dened by start_pos (an
integer) and ending at the character dened by length (an integer). If length is not indicated, it returns
the remainder of the string.
 

to_char(expr)
 

This function converts the numeric expr to a character string.
 

to_number(str)
 

This function converts the character string str to a numeric. If the str is not numeric, this function
returns zero. If str is a combination of numbers and other characters and begins with a number, this
function returns only the initial numeric portion. For example, to_number('123ABC') returns 123.
 

upper(str)
 

This function returns string str in all uppercase characters. For example, the expression
upper('global.COM')returns the value GLOBAL.COM.
 

Date Functions Select from the following to use a date function in the expression.

date_add(date, units, interval, round)
 

This function returns the value of date plus a specied amount of time where date is a datetime type
column or a literal string in the format YYYY-MM-DD or YYYY-MM-DD HH:MI:SS. The amount of
time to add is specied by units and interval, where units must be an integer specifying the number of
intervals to add, and interval can be SECONDS, MINUTES, HOURS, DAYS, WEEKS, MONTHS, or YEARS.
To round the result to the beginning of the specied interval, set the round argument to 1. Otherwise,
 set round to 0 and the result is not rounded. For example, the expression date_add('2003-11-25
22:35:00', 48, HOURS, 1) returns the value 2003-11-27 22:00:00.
 

to_date(str, format)
 

This function converts the string str in the format specied by format to a date value. For example, the
function to_date('19981231', 'YYYYMMDD') returns a date of 12/31/1998.
 
Unlike date_format, the to_date function supports only the following date formats.

1442



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Expression Description

 
DD MM YYYY HH24:MI:SS
 
DD MM YYYY HH:MI:SS AM
 
DD MON YY
 
DD MON YYYY
 
DD-MM-YY
 
DD-MM-YYYY
 
DD.MM.YY
 
DD.MM.YYYY
 
DD/MM/YY
 
DD/MM/YYYY
 
DD/MM/YYYY HH:MI:SS AM
 
MM-DD-YY
 
MM-DD-YYYY
 
MM/DD/YY
 
MM/DD/YYYY
 
MON DD YY
 
MON DD YYYY
 
MON DD YYYY HH:MI AM
 
MON DD YYYY HH:MI:SS AM
 
YY.MM.DD
 
YY/MM/DD
 
YYMMDD
 
YYYY-MM-DD
 
YYYY-MM-DD HH24:MI:SS
 
YYYY-MM-DDTHHH24:MI:SS
 
YYYY.MM.DD
 
YYYY/MM/DD
 
YYYYMMDD
 

date_format(date, format)
 

This function converts date from a datetime data type to a string and reformats date to match the
format specied by format, where date is a datetime type column or a literal string in the format YYYY-
MM-DD or YYYY-MM-DD HH:MI:SS. For example, the expression date_format('2003-11-25
22:25:00', 'DAY, MONTH DD, YYYY, HH12:MI PM') returns the value Tuesday, November
25, 2003 10:25 PM.

1443



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Expression Description

 

date_di(date, date)
 

This function returns the number of seconds occurring between two dates. For example, the
expression date_diff('2009-11-26 22:25:00', '2009-11-25 10:30:00’) returns the value
129300.
 
Another example is date_di(sysdate(),incidents.updated). This expression returns the number of
seconds between the current time and the time that incidents were last updated.
 

Note:  To change the format of the output, use the time_format function. For example,
 time_format(date_diff('2009-11-26 22:25:00', '2009-11-25 10:30:00’),
'HH24h MIm SSs') returns the value 35h 55m 00s.

date_trunc(date, units)
 

This function truncates date to the unit specied by units. For example, the expression
date_trunc('2003-11-25 22:25:10', HOURS) returns the value 2003-11-25 22:00:00.
 

sysdate()
 

This function returns the current system date in the format YYYY-MM-DD HH:MI:SS.
 

time_format (seconds, format)
 

This function converts seconds to the specied time format. For example, the expression time_
format(86610,'HH24 MI SS') returns the value 24 03 30.
 

date_group(expr, format)
 

This function groups records together according to a date range that you specify, and includes rows for
date ranges that have no associated records. If you do not want to return rows for date ranges with no
records, you could use date_format instead.
 
For example, if you have incidents created in January and March, but none in February, and create
a report with the expression for column A set to date_group(incidents.created, ‘YYYY-MM’), and the
expression for Column B set to count(*), the report would output:
 
2006-01 10
 
2006-02 0
 
2006-03 15
 
If you changed the expression in Column A to date_format(incidents.created, ‘YYYY-MM’) to use the
date_format function instead of date_group, the report would output similar data, but would not return
a row for February.
 
This function can be used only when dening group lters. See Create a Group Filter.
 

Logical Functions Select from the following to use a logical function in the expression.

if(expression, then result, else result)
 

This function returns the then result if expression is true, or returns the else result if expression is false.
For example, the expression if(incident.c$field=1, 'Yes', 'No') returns Yes for incidents
where the value of c$eld is 1. Otherwise, No is returned.
 
You can use IS NULL and IS NOT NULL as part of the expression. For example, you could use the
expression if(incident.c$field IS NOT NULL, 'Yes', 'No').
 

decode(expression, test_value_1, result_1[,
 test_value_2, result_2][, default])
 

This function compares expression to each test value in order and returns result for the rst test value
that expression matches. If expression does not match any test value, default is returned. If default is
undened, a null value is returned.
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Expression Description

The decode function can perform table lookups, leing you use text strings as test values rather than
requiring coded values. For example, you can use Review as a test value for the expression faqs.status
even though the table contains code value in the status column.
 

nvl(expr1, expr2)
 

If the value expr1 is null, this function returns the value expr2. However, if the value expr1 is not null,
 then the value expr1 is returned. The value of expr2 must match the data type of expr1.
 

Math Functions Select from the following to use a math function in the expression.

bitand(X, Y)
 

This function returns the bitwise AND of two integers, X and Y.
 

ceiling(X)
 

This function returns the smallest integer value greater than or equal to X.
 

oor(X)
 

This function returns the largest integer less than or equal to X.
 

power(X, Y)
 

This function returns the value of X to the power of Y. For example, power(2,3) would return 8.
 

rand()
 

This function returns a random number between 0 and 1, containing up to nine decimal places.
 

round(X, D)
 

This function returns the value X rounded to the nearest number with D decimals. For example,
 round(5.55555, 2) returns the value 5.56.
 

truncate(X, D)
 

This function returns the value X truncated to the D decimal places. For example, the expression
truncate(5.55555, 2) returns the value 5.55.
 

Currency Functions Select the following to use a currency function in the expression.

to_currency(expr, str)
 

This function converts expr to a value in str currency. The value is returned as an amount in the sta
member’s default currency. The conversion rate used for this function is the exchange rate dened in
the Exchange Rates (exchange_rates) table.
 
For example, for a sta member with a default currency of USD, to_
currency(opportunities.mgr_value, ‘EUR’)  returns an amount in USD that is equal to the
number in the mgr_value converted to Euros.
 

Filter Operators for Segments  
The operator you select when creating lters greatly impacts the data that is returned, so it is important to understand
the functionality of each operator.

Operator Description

equals
 

The expression matches the value exactly (including case).
 

not equals (exclude No Value)
 

The expression does not match the value exactly (including case), and does not contain a null value.
 

less than The expression is less than the value.
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Operator Description

   

less than or equals
 

The expression is less than or equal to the value.
 

greater than
 

The expression is greater than the value.
 

greater than or equals
 

The expression is greater than or equal to the value.
 

between
 

The expression is between two specied values. The between operator is available to use with date,
 currency, and numeric (integer and oat) expressions.
 
When using this operator with a date expression, records matching the date and time of the beginning
value are returned, but those matching the date and time of the ending value are not. This prevents
records from being displayed twice on a report that is run once to view records created between
9:00 AM and 10:00 AM, and run again to view records created between 10:00 AM and 11:00 AM, for
example.
 

like
 

The expression matches any part of the value. When using this operator, you should use the %
wildcard symbol to oset your value. For example, to include values containing “all,” type ‘%all%’ in
the Value eld.
 

not like
 

The expression does not match any part of the value. The % character may be used as a wildcard. For
example, to exclude values containing “all,” type ‘%all%’ in the Value eld.
 

in list
 

The expression values you want to search for are specied by selecting check boxes in a menu. The
selected options are displayed in a separate Selected Items list to assist you when selecting from
menus with a large number of options.
 
When using this operator with integer elds, the numbers in the Value eld must be comma-separated.
When using this operator with text elds, the text strings in the Value eld must be comma-separated
and each text string must be oset by single quotes. For example, ‘red’,’green’,’orange’.
Spaces between entries are ignored.
 

not in list
 

The expression values you do not want to search for are specied by selecting check boxes in a menu.
The selected options are displayed in a separate Selected Items list to assist you when selecting from
menus with a large number of options. This operator is available only with menu eld expressions.
 
When using this operator with integer elds, the numbers in the Value eld must be comma-separated.
When using this operator with text elds, the text strings in the Value eld must be comma-separated
and each text string must be oset by single quotes. For example, ‘red’,’green’,’orange’.
Spaces between entries are ignored.
 

is null
 

The expression contains a null value.
 

is not null
 

The expression does not contain a null value.
 

not equals (include No Value)
 

The expression does not match the value exactly (including case), or contains a null value.
 

not like or null
 

The expression does not match any part of the value, or contains a null value.
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Operator Description

Complex Expression
 

The expression matches any part of the value. This operator allows wildcard searching using an
asterisk (*) at the end of a word or partial word and a tilde (~) before a word to perform a similar
phrases search on that word only. See Special Characters Allowed When Searching.
 

Not Complex Expression
 

The expression does not match the complex expression in the value. The Not Complex Expression
operator is available only with text eld expressions.
 

Related Topics
• Functions for Segments

• Add Filters to a Segment

Edit a Logical Expression  
When you add multiple lters to a segment, the lters are automatically joined together with a logical expression. This
denes how the lters should work together to return data.

By default, the logical expression uses Boolean AND logic. For example, if you have a lter of contacts.prov_id = MT, and
a lter of contacts.ma_state = Yes, the logical expression is contacts.prov_id = MT AND contacts.ma_state = Yes. This
expression would result in the report returning only contacts that are from Montana and are in the Outreach state.

You can edit logical expressions to limit your data set by using dierent Boolean operators to connect your lters.

• The AND operator retrieves data matching all of the lters.

• The OR operator retrieves data matching any of the lters.

• The NOT operator (represented by an exclamation point) excludes matching data.

When you add nodes to the expression, the nodes are displayed in a tree structure, with lters displayed either under an
AND node or an OR node. Filters under the same AND node are joined to each other using AND logic, and lters under
the same OR node are joined to each other using OR logic.

NOT logic is achieved by negating a lter, which displays in the Filters section preceded by an exclamation point. For
instance, if you negate the lter description contacts.prov_id = MT, the description appears as !contacts.prov_id = MT
(equivalent to NOT contacts.prov_id = MT).

1. From an open segment, add more than one lter to the Filters section.
This image shows an open segment with two lters.
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The lters you add are automatically joined with AND logic and are displayed in an AND tree.

2. To add a lter joined with OR logic to the logical expression:
a. Click Add OR Node in the Actions section.

The node is added to the logical expression.
b. Click the lter that should be joined with OR logic and drag it to the new OR node.

3. To negate a lter, select the lter and click Negate Filter in the Actions section.
4. To view a text denition of the logical expression for the current lters, click View Text Denition.

The Text Denition window opens.
5. To display the lter description instead of the lter name, click Display Filter Descriptions.

The lter description includes the eld name, operator, and value. For example, a lter named Contacts in MT
could be described as contacts.prov_id = MT.

Edit the Data Set  
The data set consists of the database tables the segment is referencing.

The Contacts (contacts) table is automatically added to the data set when you create a segment. When you add elds
from dierent database tables as lters or add more than one table to the data set, the tables that contain the elds are
automatically joined together. This lets you use data from tables related to contacts; for example, incidents.
Tables can be joined using two methods, or join types:

• Inner join—Inner joins select records from the joined tables on the condition that the value in the specied
column of the primary table is equal to the value in the specied column of the secondary table. For example, if
the Incidents table is joined to the Contacts table with an inner join, contacts without an associated incident are
not included.

• Outer join—Outer joins select rows from two tables regardless of whether the specied columns contain
corresponding values. An outer join returns all rows from the primary table and any rows from the secondary
table where the value in the specied column of the primary table is equal to the value in the specied column
of the secondary table. For example, if the Incidents table is joined to the Contacts table with an outer join,
contacts without an associated incident are included.

Note:  Tables are automatically added to the data set when you select columns to lter by in the segment.

1. Click Edit Data Set in the Advanced Options section.
The Edit Data Set window opens, listing the tables in your segment and their relationships.

2. To add another table, right-click the table you want to join to, select Join To, and select the table and columns
you want to join (for example, Incidents >contact.c_id=incidents.c_id). Repeat this step for each table you want
to add.

3. To edit table join information, click the table that is joined to the parent table.
This image shows the table that is joined to the parent table and the available join options which are dened in
the Edit Data Set window table.
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a. Enter eld information.

Field Description

Table
 

This eld displays the database name of the table you have selected.
 

Delete Table
 

Click Delete Table to remove the table you have selected from the segment. If
the table acts as a parent to other tables in the segment, the child tables are
also removed.
 

Alias
 

This eld displays the alias name of the table you have selected. The alias
allows for multiple instances of the same database table to the same
segment. For example, the rst instance of the Contacts (contacts) table
would have an alias of “contacts,” and the second instance would have an
alias of “contacts2” to distinguish it from the rst instance.
 

Join To
 

This eld displays the table that the selected table is joined to.
 

Join Condition
 

If more than one eld relationship is available to join the tables, click this
drop-down menu to select the elds on which to join.
 
If only one eld relationship is available, the menu displays only that option.
 

Join Type
 

Select the Inner option to use an inner join and the Outer option to use an
outer join.
 

Tip:  To change the join type, you can also right-click the joined
table in the Data Set tree and select Toggle Join Type.

Join Filters
 

If you select the Outer join type, the option to add join lters becomes
available.
 

4. Click OK.
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Create Outer Join Filters  
When you create an outer join, you can add join lters to lter the data returned from the secondary table without
ltering the data from the primary table.

Join lters are similar to segment lters in that they limit the records that can be returned by the report, but they apply
to the table join rather than to the data returned by the query on the database.

1. Select a joined table in the data set tree.
2. Select Outer as the join type.

The Join Filters heading displays.
3. Expand the Join Filters heading on the Edit Data Set window.

The Edit Data Set window displays the Join Filters section.
4. Click Add Filter.

The Add Filter window opens.
5. Enter eld information.

Field Description

Name Enter the name of the lter. If you leave this eld blank, the database name displays.

*Expression Enter the expression you want to use to limit the data set in this eld. The syntax is
<table_name>.<column_name>. As you type an entry in the Expression eld, a drop-
down menu displays a list of database tables that begin with the leers you type. You
can enter the complete expression or select a table and eld from the drop-down menu.
You can also select a table and column or function by right-clicking in the eld.
 

Tip:  If you drag and drop a column name from the Fields section, the eld
contains the table and column name.

Operator Select the operator to use in comparing the expression to the value. The available
operators vary depending on the expression.

Value Type Select the type of value to match with the expression from these options.

Constant
 

Select this option to enter the value to complete the lter or select the value from a
drop-down menu or calendar (depending on the expression).

Expression
 

Select this option to enter an expression to complete the lter, using the syntax
<table_name>.<column_name>.

Value Enter the value that the expression is compared to. The available options in the Value
eld change depending on the type of eld, the operator you select, and the value type.
For example, when the eld type is menu, you select it from a drop-down menu, but
when the eld type is date, you select if from a calendar.

6. Click OK.
The Edit Data Set window is updated to display the lter, along with additional actions.

The additional actions that become available are identical to those used when creating logical expressions for
segment lters. These actions let you edit your lter, create additional lters, add OR logic to the join lters,
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negate lters, and view a text denition of the join lter logical expression. For procedures on using these
actions, see Edit a Logical Expression.

Create a Group Filter  
You can create group lters to specify the lters to use on grouped data.

Group lters are applied to the data after the grouping is completed and must be aggregate functions. For example, if
you join the Contacts (contacts) table to the Marketing Activities (ma_trans) table, create a xed lter for ma_trans.type
of email Sent, group by contacts.c_id, and use the group lter count(*) > 10, then only those contacts that have been
sent more than ten emails will be selected in the segment.

1. From the Criteria tab, click Edit Group Filters.
The Edit Groups window opens.

2. Click Add Filter
The Add Filter window opens.

3. Enter eld information on the Add Filter window. See How Segment Filters Work.
4. Click OK to save the group lter.

The additional actions that become available are identical to those used when creating logical expressions for
segment lters. These actions let you edit your lter, create additional lters, add OR logic to the join lters,
negate lters, and view a text denition of the join lter logical expression. See Edit a Logical Expression.

5. Click OK.

Preview a Segment  
After dening your lters, you may want to see which contacts meet the segment criteria. You can preview the segment
to see a list of up to 1,000 contacts.

1. Click the Preview tab.
The contacts’ rst name, last name, and email address display. If any contact elds are used to lter the
segment, they are also included as output columns in the list.

2. To change the number of contacts that display per page, click  Options > Paging .
The Report Paging Options window opens.

3. Enter the number of rows you want to display per page and click OK.
4. To edit a contact record, select the contact and click Open. See Edit a Contact.
5. To print a contact record, select the contact and click Print.
6. To access report options, such as sorting and exporting, click Options. See How You Distribute Reports and

Dashboards.

Analyze a Segment  
The segment analyzer examines your segment and provides suggestions as to how you can improve the segment by
removing database tables, adding lters, and making other changes.

The analyzer also shows you the estimated number of rows the segment query may need to access so you know if the
segment can run without encountering row limits.

Tip:  After you create or edit a segment, we recommend that you run the segment analyzer to check the
segment database queries. This lets you ne-tune your segments to ensure they run as quickly and eciently
as possible.

1. Open the segment you want to analyze.
2. Click Analyze on the ribbon Home tab.

The Segment Analyzer window opens.
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The segment analyzer lists the segment lters, tables, output levels, and the estimated number of rows the
segment query examines when it runs. If the analyzer nds potential issues with the segment query, it lists the
issues in the Notes column next to the applicable segment component.

The following table describes the four segment components included on the Segment Analyzer window and
lists the messages you may see in the Notes column when potential issues are found.

Segment Component Potential Issue

Filters
 

This section lists the expressions used for each segment and level lter and identies
whether the lter elds are indexed in the database and whether the index is used.
Custom elds can be indexed for faster queries, though too many indexes can slow
down queries. Only the following message can be returned in this section.
 

◦ The lter contains a custom eld that does not have an index. To improve the
performance of this query, consider adding an index on the custom eld.

Tables
 

This section lists the tables that are used in the segment, along with the types of joins
used to link the data in the tables. Two messages can be returned in this section.
 

◦ This table is in an outer join but there are one or more lters on elds in this table.
Make sure this is by design. If not, consider changing the join type to inner or
changing these lters to join lters to prevent an implicit inner join.

◦ This table is not used in the report. Consider removing the table from the data set.
If you need to lter out rows in the parent table that do not have rows in this table,
 consider adding a not null lter on the join eld in the parent table.

Levels
 

This section does not apply to segments even though it displays in the report.
 

Rows
 

This section lists the estimated number of rows that will be examined by the query.
Messages are displayed if the number of rows exceeds the threshold values for the
operational and report databases. Three messages can be returned in this section. The
messages vary depending on whether your site has a report database in addition to the
operational database.
 

◦ The estimated number of analyzed rows for this query is X. This value exceeds the
threshold of 2,000,000 for the operational database. Consider using the report
database for this report. Otherwise, it is likely this will occur automatically.

◦ The estimated number of analyzed rows for this query is X. This value exceeds the
threshold of 2,000,000 for the operational database. Since you have specied the
operational database for this report, it is unlikely the report will execute. Consider
using the report database for this report.

◦ The estimated number of analyzed rows for this query is X. This value exceeds the
threshold of 5,000,000 for the report database. Consider adding or rening lters
to reduce the number of analyzed rows to below this threshold. Otherwise, it is
unlikely the report will execute.

3. Click X on the top right to close the Segment Analyzer window.
4. Click X on the top right to close the segment.

Export a Segment  
Exporting and importing segments saves you time by leing you reuse your segments.
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There may be situations when you want to use the same segment in multiple interfaces, websites, or custom reports.
You can export your segments as XML les and then import the les to use again. See Import a Report from an XML
File.

1. Open the segment you want to export.
2. Click Export on the ribbon Home tab.
3. Save the new XML le.

Import a Segment  
Exporting and importing segments saves you time by leing you reuse your segments.

There may be situations when you want to use the same segment in multiple interfaces, websites, or custom reports.
You can export your segments as XML les and then import the les to use again. See Import a Report from an XML
File.

1. On the Segments explorer, click New.
2. Click Import Segment.

Note:  You must have exported an XML segment and saved it to a location where you can access it
before it can be imported.

3. Select the XML segment le you want to import and click Open.

The segment displays on the Data Dictionary window.

Example of Creating a Segment  
This procedure uses a real-world scenario to walk you through the creation of a segment.

In the following example, a segment is created to return a data set of contacts who live in the state of Montana and
have submied an incident assigned to a certain product. The example works under the premise that there is a product
named Call Plans. For information about creating products, see Add or Edit a Product , Add a Subproduct, and Edit
Visibility Seings for Multiple Products Simultaneously.

1. From the Segments explorer, click New.
A new segment opens on the content pane.

2. Click New Segment.
The Segment editor opens on the content pane.

3. Click Contacts under Current Dataset in the Data Dictionary section on the Criteria tab.
4. In the Fields section, drag State/Province (prov_id) and drop it in the Filters section.

The Edit Filter window opens with the contacts.prov_id eld populating the Expression eld.
5. Click the Value drop-down menu and select MT.
6. Click OK.
7. Click Incidents under All Tables in the Data Dictionary section.
8. In the Fields section, drag Product Hierarchy (prod_hierarchy) and drop it in the Filters section.

The Edit Filter window opens with the incidents.prod_hierarchy eld populating the Expression eld.
9. Click the Value drop-down menu and select Call Plans.

10. Click OK.
The segments display on the content pane with the criteria you dened.

11. Click Save, enter the segment name in the Name eld of the Save As window, and click Save.

The segment can now be used in mailings and surveys to target only those contacts with an address in Montana who
have submied an incident associated with call plans.

How You Improve Conversion Rates  
A successful broadcast mailing is largely dependant on the quality of your contacts. This topic includes steps you can
take to improve your organization’s conversion rates.
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A common myth about sending broadcast email is that—like direct mail—the larger your audience, the more likely your
mailing is to be successful. In reality, succeeding with broadcast email depends more on the quality of contacts than the
quantity. Sending email to people who have no interest in your product or service not only drags down your conversion
rates, it can land you on blacklists and block delivery of future mailings across large swaths of the Internet.

One of the most eective ways to improve conversion rates is to lter your contacts by email viewing history. The
system keeps track of each contact’s marketing activity in the Marketing Scorecard (ma_scorecard) table. When a
contact views a mailing, the ma_scorecard.last_view eld is updated with the date and time that the message was
viewed. Knowing whether a contact recently viewed a message provides a reasonable basis for judging contact quality.

There are several reasons a contact might not view a message. For example, the message may contain an unfamiliar
From address or an ambiguous subject line. It may be ltered as spam, bounced or blocked by the recipient’s mail
server, or rejected due to the sender’s reputation. Whatever the reason, it is safe to assume that a contact who has not
viewed a recent mailing is not likely to view one in the future.

Conversely, a contact who recently viewed a message is more likely to view future messages. Therefore, to optimize
your conversion rates and protect your reputation, we recommend that you add the following lter to all segments:

• ma_scorecard.last_view greater than -90 Days Exactly (Relative)

This lter limits your segment to a list of contacts who have viewed at least one mailing within the past ninety days.

Tip:  After you have added this lter to a segment and included the segment in an audience, be sure to
perform an audience count. If the segment returns too small an audience, adjust the date value dened by the
ma_scorecard.last_view lter to be less restrictive. But remember—the longer contacts go without viewing a
mailing, the more likely they are to lower your conversion rates.

The contacts in the resulting list will be more likely to view future messages than contacts who are not listed. You can
also assume that their email addresses are valid and that they are not marking your messages as spam. Therefore, the
quality of these contacts is high.

Another way to improve conversion rates is to track your contacts’ engagement score. Based on historical contact
interactions within Oracle Service Cloud, the system evaluates each contact and assigns a contact engagement score on
a scale from 0 to 100. This statistic is based on each contact’s hourly transaction history, such as content viewed, links
clicked, web form and survey submials, marketing emails forwarded, SmartSense ratings, and service transactions.
Score value is stored in the ma_scorecard.score eld, which is available for reports (for example, the Engagement
Scorecard report), segments, and campaign decisions.

Note:  Data older than 400 days is automatically truncated from the following tables: Marketing Activities
(ma_trans), Bounced Messages (bounced_msgs), and Mailing Exclusions.

The Marketing Stats (ma_stats) table summarizes records in the Marketing Activities (ma_trans) table that share a
unique combination of mailing_id, format_id, doc_id, ow_id, ow_web_page_id, and type values. This ensures that
summary marketing transaction statistics remain available indenitely, even after the originating ma_trans records have
been truncated. All transactions related to unsubscribe, including list-unsubscribe header, feedback loop unsubscribe,
and unsubscribe, will remain in the Marketing Activities table.

To ensure optimal conversion rates and protect your reputation, you should adopt a regular contact evaluation process
to ensure that all contacts are valid and active.
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Contact Opt-In Management  
Although many of your customers may want to be included in your mailings or survey invitations, it is not uncommon
for some to decline. In fact, anti-spam legislation in most countries requires that you provide a way for your contacts to
easily opt out of all mailings.

An eective opt-in process can also provide numerous benets, including the following:

• Arming contact receptiveness to your messages.

• Targeting the interests of your valued prospects and customers to provide more pertinent information without
overwhelming their inboxes.

• Optimizing your contact data to improve conversion rates.

• Protecting your company reputation among ISPs.

To help track your customers’ messaging preferences, Oracle Service Cloud provides two types of opt-in elds.

• Global Opt-in—is a contact database eld that describes the willingness of your contacts to receive any form of
bulk mailing.

• Custom opt-in elds—are contact custom elds of an opt-in data type that can be used to more precisely
describe the willingness of contacts to receive bulk mailings about specic topics or products.

Opt-in elds are often made visible on the Account Seings page of the customer portal so that customers can set their
own preferences for accepting bulk email. Opt-in elds are also commonly paired with unsubscribe links in mailings and
survey invitations to provide contacts with a simplied means of opting out. See Insert an Unsubscribe Link.

Contacts that are globally opted in are considered fully active and willing to receive your communications. Alternately,
contacts that are globally opted out should be regarded as though they have explicitly stated that they do not want to
receive bulk email from your company—they should be excluded from all mailings and surveys. Global exclusions are
enabled by default by the Honor Global Opt-in check box on the Audience tab of mailings and surveys. See Dene the
Broadcast Mailing Audience.

Exclusions based on custom opt-in elds are manually enabled by adding a lter to your segments, such as
contacts.<opt-in_eld_name> not equals No, or by adding a special segment to your audience as described in the
following procedure.

Related Topics
• CAN-SPAM Compliance

• Contact Opt-Out Tracking

• Exclude Contacts Based on a Custom Opt-In Field

Exclude Contacts Based on a Custom Opt-In Field  
Exclusions based on custom opt-in elds are manually enabled by adding a lter to your segments.

You could add a lter such as contacts.<opt-in_eld_name>  not equals No, or you could add a special segment to your
audience as described in the following procedure.

1. Click Audiences on the navigation pane.
2. Double-click Segments Explorer.

The Segments explorer opens on the content pane.
3. Click New on the ribbon. A new segment opens on the content pane.
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Tip:  You can also exclude a segment based on a custom opt-in eld from an open segment by clicking
New. Additionally, if your navigation set is congured to add segments from the le menu, click  File >
Audience > Segment . See Congure the File Menu.

a. To create a segment from scratch, click New Segment.
b. To create a segment by copying an existing segment, click Choose Existing Segment.

The Choose Existing Segment window opens where you can select the segment you want to use.
c. To import an XML segment, click Import Segment. See Import a Segment.

4. Click Add Filter. The Add Filter window opens.
a. Enter the opt-in eld name in the Expression eld.
b. Select No from the Value eld.
c. Click OK.
d. Click Save and Close to save the segment.

5. From the Audience tab of an open mailing, click Add Segment in the Excluded section.
6. Select the segment you created and click OK.
7. Click Save.

Contact Opt-Out Tracking  
Oracle Service Cloud records transactions for global opt-ins and opt-outs in the contact audit log.

While global opt-outs are generally performed by contacts themselves, there are many methods by which a contact can
be opted out.

Method Description

Contact Record
 

A sta member set the Global Opt-in eld to No in the contact record.
 

Account Seings
 

The contact set the Global Opt-in eld to No on the Account Seings page on the customer portal.
 

Unsubscribe Link
 

The contact clicked an unsubscribe link that was included in a served web page or delivered email.
 

Web Page Link
 

The contact opted out by form submission.
 

Data Import
 

The contact was opted out when the contact record was uploaded by the Data Import Wizard.
 

List-Unsubscribe Header
 

The contact clicked an opt-out buon in the mail client that appeared as a result of the List-
Unsubscribe mail header.
 

Automatic Feedback Loop
 

The contact clicked a spam notication feature provided by the contact’s email service, which relayed a
notication to Oracle Service Cloud, and the contact was opted-out by the system.
 

In addition to the audit log, the system provides the following reports to help you identify the methods responsible for
opting out contacts.

• Mailing Opt-out Details—Lists all contacts who opted out as a result of a mailing and the opt-out method used.

• Contact Opt-out Details—Lists all contacts currently opted out and (if available) the opt-out method used.
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• Outreach Activity—Includes information about contacts who opted out using the List-Unsubscribe Header or
Automatic Feedback Loop methods.

• Mailing Response Analysis—Includes the total number of opt-outs that occurred using the List-Unsubscribe
Header or Automatic Feedback Loop methods.

CAUTION:  Administrators noticing a large number of global opt-outs may be tempted not to include
unsubscribe links in mailings. However, you should be aware that in many countries, including the United
States, the inclusion of unsubscribe links in marketing email is required by law. See CAN-SPAM Compliance.
If your site is experiencing higher-than-usual opt-out rates, the recommended best practice is to increase the
deliverability of your communications.

Content Library  

Overview of Content Library  
The Content Library is a resource for creating, storing, and organizing custom content such as documents, templates,
tracked links, and snippets. When saved, you can access this content whenever you need to include it in a mailing,
campaign, web page, or survey.

You can use the content as is, or make minor changes after it has been added. You can also upload le aachments
once and include them in your content as many times as you like.

The HTML editor lets you create dynamic documents to send to your customers in mailings, surveys, and notications.
You can add graphics, hyperlinks, tables, and apply text formaing without having any knowledge of HTML. Should you
need to modify the source code, the editor provides easy access with a technical interface.

You can also add web forms to documents, templates, and snippets to collect customer data from the web or through
email. You can add any database contact eld or contact custom eld to the web form, enabling you to populate a
contact record with data from the submied form.

Related Topics
• How the HTML Editor Works

• Insert a Web Form

Create a Document  
You can create unique documents to use in mailings, campaigns, and surveys. Documents can be designed in either
HTML or plain text, and are easily previewed while being created. You can also access tasks and notes associated with
the document, and an audit log of actions taken on the document.

After a document is created, it can be served as a web page in a campaign, sent to contacts in a mailing or survey
invitation, or used to form a questionnaire in a survey. Documents can contain templates, web forms, snippets, merge
elds, merge reports, and conditional sections based on contact lters. However, mailings and surveys using simpler
documents send more quickly than those using documents with many merge elds, merge reports, conditional
sections, and web forms.
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Note:  The following procedure assumes that you access the Documents explorer from the Content Library
navigation list. However, this explorer may reside in a dierent navigation list.

1. Click Content Library on the navigation pane.
2. Double-click Documents Explorer.

The Documents explorer opens on the content pane.
3. Click New.

A new document opens on the content pane.

Tip:  You can also create a document from an open document by clicking New. Additionally, if your
navigation set is congured to add documents from the le menu, click  File >  Content Library >
Document . See Congure the File Menu.

By default, the Summary tab is active when creating a document. From here, you can assign the document to
a sta member, as well as manage document notes, tasks, and aachments. See How Documents Work. The
Notes, Tasks, Aachments, and Audit Log tabs are available only when the Summary tab is selected.

4. To assign the document to another sta member (by default, the document is assigned to the sta member
who creates it), click the Assigned drop-down menu and select the sta member.

Tip:  Wildcards are supported when searching sta members. You can search strings that include
a space by entering %+Space+character, which is helpful when searching last names. For example,
typing %+Space+b returns all last names starting with the leer b. There is also an implied wildcard when
searching, so typing b in the Find eld returns all items containing the leer b.

a. To search for a sta member, enter the sta member’s name in the Find eld.
5. To let sta members to serve this document as a web page, select the Approved for Web check box.
6. To let sta members to use this document in a mailing or survey, select the Approved for Email check box.
7. To create an HTML version of the document, click the HTML tab and see Create an HTML Document.
8. To create a plain-text version of the document, click the Text tab and see Create Text Content in Documents.
9. To spell check the document, click Spelling on the ribbon and see Spell Checking.

10. Click Save.
The Save As window opens.

11. Select the folder you want to save the document in and type the name of the document in the Name eld.
12. Click Save.

Create an HTML Document  
When you create HTML documents, you have the option of starting with a blank document, copying an existing
document, using a template, or uploading your own HTML to the document.

HTML documents can be modied by editing the source code, or using an HTML editor to add images, formaing
or insert special links, such as tracked links or links to unsubscribe to mailings. You can also add conditional sections,
merge elds, and merge reports to your HTML documents.

1. Click the HTML tab.
2. To create an HTML document from scratch, click Begin with Blank Content.

The HTML editor opens. See How the HTML Editor Works.
3. To create an HTML document by copying an existing document, click Copy Existing Document. The Choose

Document window opens.
a. Select the document you want to copy.
b. Click OK to add the content to your document.
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Note:  Changes to the document content do not aect the original document.

4. To create an HTML document by uploading a template, click Pick a Template. The Choose Template window
opens.

a. Select the template you want to use.
b. To create a template, click New Template and see How Templates Work.
c. Click OK to use the template in your document.

5. To create an HTML document by uploading an HTML le from your workstation, click Upload HTML Content.
a. Select the HTML le you want to upload.
b. Click Open to insert the HTML into your document.

6. Click Save.

Create Text Content in Documents  
You may want to create a text version of your document if certain customers can receive only plain text emails. When
you create text documents, you can start with a blank document, upload the text portion of an existing document, or
convert an HTML le.

1. Click the Text tab.
2. To create text content from scratch, click Begin with Blank Content.

The text editor opens. See How You Create and Edit Text-Only Messages.
3. To create text content by copying an existing document, click Copy Existing Document. The Choose Document

window opens.
a. Select the document you want to copy.

Note:  Only the text content from the document is copied. The HTML content of the document is
not aected.

b. Click OK to add the content to your document.
4. To create a text document by converting an HTML page to text, click Convert HTML Content. The HTML to

Text window opens.
a. To convert the HTML content to text, select HTML Part. This option is not available if no HTML content

exists in the document.

Note:  You should nalize your HTML content before converting it to text.

b. To convert an HTML le to text, select File On Disk and browse for the le.
c. Click OK to insert the converted HTML in the text part of your document.

5. Click Save.

How Documents Work  
You can view click-through results for a document and add notes, tasks, and le aachments to your documents. You
can also view the audit log to see when a document was created and edited.

The following sections describe how to view click-through results and add notes and tasks.

• View Click-Through Results

• Add a Note to a Document, Mailing, or Survey

• Add a Task to a Document

To add le aachments and view the audit log, see Overview of the Aachments Tab and Audit Logs.
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View Click-Through Results  
Documents can be viewed with click-through results for tracked links, web page links, le links, unsubscribe links, and
forward to friend links.

Following each link, inline statistics display the number of times the link was clicked, the number of total link clicks in
the document, and the percentage of times the link was clicked when compared to total clicks. The links are also color
coded so you can immediately see how they are performing. Links that perform well appear in green, underperforming
links appear in red, and all other links appear in yellow.

1. From the Documents explorer, do one of the following:

◦ Right-click the document and select View Click-Through Results.

◦ Click View Click-Through Results on the Documents explorer ribbon.

Add a Note to a Document, Mailing, or Survey  
You can use notes to provide additional information about the content that can be viewed by sta members as they are
working with the document, mailing or survey.

1. On the Summary tab of an open document, mailing, or survey, click the Notes tab.
2. Click Add.
3. Enter the note text in the text eld.
4. To sort the notes by ascending or descending date, click the Sort drop-down menu and select the sort option.
5. To edit an existing note, click Edit next to the note.
6. To permanently delete a note, click Delete next to the note.

Add a Task to a Document  
From the Summary tab, you can assign new or existing tasks to documents and edit, delete, and forward tasks to other
sta members. You can also view each task associated with the document.

1. From your open document, click the Tasks tab.
2. Enter eld information.

Buon Description

Add Click this buon to display a drop-down menu containing the following options.

Add New Select this option to add a new task. See Add a Task for the procedure to complete the
elds on this window.

Add Existing Select this option to add an existing task. After nding and selecting a task, the task is
added to the task list for the document. See Search for a Task from an Open Record for
information about the Task Search window.

Open Click this buon to open the selected task for editing.

Print Click this buon to print the task.

Copy Click this buon to copy the task.

Delete Click this buon to permanently delete the task.

Remove Click this buon to remove the task from the document (without deleting the task).
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Buon Description

Complete Click this buon to set the task status to Completed.

Forward Click this buon to open the Forward Task window and send the task to the selected
recipients.

Options Click this buon to select an option for managing the output and display of information
on the tab, such as print, forward, or export.
See Forward a Report, and Export Report and Dashboard Data. For information about
other options, see How You Change Report Formaing.
 

How Templates Work  
Templates are used to standardize the design of the headers and footers of your documents. When you apply a
template to a document, the template design appears as part of the document layout.

However, the template design cannot be edited from the document editor—you can edit only the contents of the
document, indicated by a red outline. To make changes to the template, you must open it in the template editor. See
Create a Template.

Templates are sometimes referred to as “living” content. When a template is edited and saved, all documents using the
template automatically display the updated content. For instance, if you design a template containing a standard header
and apply it to multiple documents, any changes made to that template appear automatically in every document that
the template was applied to.

In certain cases, you may be beer o using a snippet. Consider the following when deciding whether to use templates.

• Templates are best used for applying a common look and feel to a group of documents that will be published to
the web (using the Serve Web Page campaign element, for instance). For documents used in a mailing or survey
invitation, it is beer to add design elements using snippets.

For example, if a template is applied to a document used by a mailing, and the template is later edited, the
mailing is updated in Oracle Service Cloud to reect the edits. This occurs even if the mailing has already been
sent and the RNM_MOD_SENT_DOCS conguration seing is set to disable the editing of sent documents. If
the template is edited after the mailing is sent, and a sta member views the mailing from the mailing editor
or the Outreach Activity tab of a recipient’s contact record, the mailing no longer appears as it did when it was
sent. This can cause confusion and ambiguity about the eectiveness of the mailing.

• When you insert a snippet, its contents are copied to the layout and can then be edited freely with the rest of
the design. You can also edit the snippet at any time without aecting the appearance of layouts to which the
snippet was previously applied. See Create a Snippet.

• Another alternative to using templates is to store your design in an HTML le outside of Oracle Service Cloud
and then upload it when you create your mailing or survey. See Upload HTML Content.

If you need to update a template that has been applied to a document, you can click Info on the Home tab ribbon to
display the template ID. You can then search for the template in the Templates explorer by clicking Find on the ribbon
and selecting ID from the Find Using drop-down menu. See Find a Document.
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Tip:  To see a list of documents that are using a template, you can create a report from the Documents
(documents) table that uses the live_rc_id lter. For example, using the Documents table, you could add
columns, such as Name, Date Created, Date Updated, and Assigned, and then add the live_rc_id lter to the
report to see which templates are returned in the list. See Overview of Creating Custom Reports.

Document templates are not applied when surveys are viewed on mobile devices because templates are not optimized
for mobile. However, if you want to create an appropriately sized template to be used for mobile, you could add HTML
content with a conditional section for mobile runtime that includes a smaller image. See How You Customize Surveys for
Use on Mobile Devices.

Create a Template  
Templates are used to standardize the design of the headers and footers of your documents. Templates are sometimes
referred to as “living” content. When a template is edited and saved, all documents using the template automatically
display the updated content.

1. Click Content Library on the navigation pane.
2. Double-click Templates Explorer.

The Templates explorer opens on the content pane.
3. Click New.

A new template opens on the content pane.

Tip:  You can also create a template from an open template by clicking New. Additionally, if your
navigation set is congured to add templates from the le menu, click  File > Content Library >
Template .

4. To create the template from scratch, click Begin with Blank Content.
The HTML editor opens. In the middle of the HTML editor is a placeholder for document content when the
template is used. You can insert HTML above and below the placeholder, including in the header and footer. See
How the HTML Editor Works.

Note:  The template must include the content placeholder.

5. To create a template by copying an existing template, click Copy Existing Template. The Choose Template
window opens.

a. Select the template you want to copy.
b. Click OK to add the content to your template.

After uploading your HTML, you must insert the placeholder by clicking Content Placeholder in the toolbox.
6. To create a template by uploading an HTML le from your workstation, click Upload HTML Content.

a. Browse to the location of the HTML le you want and select it.
b. Click Open.

The HTML is inserted in your template.
After uploading your HTML, you must insert the placeholder by clicking Content Placeholder in the toolbox.

7. To spell check the template, click Spelling on the ribbon.
8. Click Save.

The Save As window opens.
9. Select the folder you want to save the template in and type the name of the template in the Name eld.

10. Click Save.
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Related Topics
• How Templates Work

• Congure the File Menu

How Snippets Work  
Snippets are small pieces of commonly used content that can be inserted into the layout of a document, mailing
message, survey, or survey invitation.

Creating a snippet is helpful if you want to make certain design elements available to any document, mailing, or survey.
Snippets can be accessed easily and reused as many times as needed. When you insert a snippet, its contents are
copied to the layout and can then be edited freely with the rest of the design. Changes made to a snippet in the snippet
editor do not alter the appearance of layouts to which the snippet was previously applied.

Tip:  If you want to apply design elements that can be updated automatically across multiple documents, you
might consider using a template instead of a snippet. When a template is edited and saved, all documents
using the template automatically display its updated content. However, templates are best used when working
with groups of documents that will be published to the web (using the Serve Web Page campaign element,
for instance). When designing documents that are used for mailings or survey invitations, it is beer to use
snippets.

You can also store your design in an HTML le outside of Oracle Service Cloud and then upload it when you create your
mailing or survey. See Upload HTML Content.

Create a Snippet  
Snippets are small pieces of commonly used content that can be inserted into your content.

1. Click Content Library on the navigation pane.
2. Double-click Snippets Explorer.

The Snippets explorer opens on the content pane.
3. Click New.

Tip:  You can also create a snippet from an open snippet by clicking New. Additionally, if your
navigation set is congured to add snippets from the le menu, click  File > Content Library >
Snippet . See Congure the File Menu.

A new snippet opens on the content pane.
By default, the snippet type is HTML. You can also create plain text snippets. See Create a Text Snippet.

4. To create an HTML snippet from scratch, click Begin with Blank Content.
The HTML editor opens so you can design the HTML in your snippet. See How the HTML Editor Works.

5. To create an HTML snippet by copying an existing snippet, click Copy Existing Snippet. The Choose Snippet
window opens.

a. Select the snippet you want to copy.
b. Click OK to add the content to your snippet.

6. To create an HTML snippet by uploading an HTML le from your workstation, click Upload HTML Content.
a. Browse to the location of the HTML le you want and select it.
b. Click OK to insert the HTML into your snippet.
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7. To spell check the snippet, click Spelling on the ribbon.
8. Click Save.

The Save As window opens.
9. Select the folder you want to save the snippet in and enter the name of the snippet in the Name eld.

10. Click Save.

Related Topics
• How Snippets Work

Create a Text Snippet  
You may want to create a text version of your snippet to insert in text documents. Text documents are used if certain
customers can receive only plain text emails.

1. From the Snippets explorer, click New.
A new snippet opens on the content pane.

Tip:  You can also create a snippet from an open snippet by clicking New. Additionally, if your
navigation set is congured to add snippets from the le menu, click  File > Content Library >
Snippet . See Congure the File Menu.

2. Click Change in the Current Snippet Type section.
The Snippet Type window opens on the content pane.

Note:  You can also change to a text snippet while creating an HTML snippet by clicking Switch to Text
Mode in the Tasks section of the HTML editor.

3. Select Text Snippet.
4. Click OK.

The snippet type changes to Text.
5. To create a text snippet from scratch, click Begin with Blank Content.

The text editor opens where you can dene the plain-text version of your snippet. See How You Create and Edit
Text-Only Messages.

6. To create a text snippet by copying an existing snippet, click Copy Existing Snippet. The Choose Snippet
window opens.

a. Select the snippet you want to copy.
b. Click OK to add the content to your snippet.

7. To create a text snippet by converting an HTML page to text, click Upload HTML Content.
a. Browse to the HTML le you want to convert and select it.
b. Click Open to insert the converted HTML in the snippet.

8. Click Save.

Related Topics
• How Snippets Work

Add a Tracked Link  
You can add links that are tracked and reported on for statistical purposes.
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The number of times a link was clicked through is reported when editing the mailing or survey and through analytics.
See View Mailing Results.

After you have added tracked links to your system, they can be inserted in documents, templates, or snippets. See Insert
a Tracked Link. Tracked links can also be inserted in several of the standard system-generated contact email messages.
See How You Customize Messages. Adding tracked links to your contact emails are especially useful in tracking your
customer-facing incident responses. See Incident Response Tracking.

Note:  Due to the volume of tracked links that accumulate as new content is created, the Agedatabase utility
regularly purges the database of orphaned tracked links. That is, links that have been dened but not used
in any campaign, document, or mailing. The PURGE_TRACKED_LINK_DAYS conguration seing species
the number of days after which an orphaned tracked link is purged from the database. The default value is 30
days. Set to 0 to turn o tracked link purging.

1. Click Content Library on the navigation pane.
2. Double-click Tracked Links Explorer.

The Tracked Links explorer opens on the content pane.
3. Click New.

Tip:  You can also create a tracked link from an open tracked link by clicking New. Additionally, if your
navigation set is congured to add tracked links from the le menu, click  File > Content Library >
Tracked Link . See Overview of Navigation Sets.

A new tracked link opens on the content pane.
4. Enter eld information.

Field Description

URL
 

Enter the full URL of the tracked link in this eld.
 

Open URL
 

Click this icon to open the URL.
 

Merge Field
 

Click this icon to add a contact, incident, opportunity, or tracked link merge eld to the
URL.
 

Menu Access Disabled
 

Select this check box to make the tracked link unavailable. Sta members cannot insert
the link in a document.
 

Unsubscribe
 

Select this check box to increment the unsubscribed count when this link is clicked in a
mailing or survey.
 

Note:  Clicking the link does not change the contact’s opt-in status. Select this
check box if you want to manage opt-in information outside of Oracle Service
Cloud.
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Field Description

Category
 

Click this drop-down menu and select a category to associate with the link. See Add or
Edit a Tracked Link Category.
 

Description
 

Enter a description for the tracked link in this eld. The description is for internal use
only and is not seen by contacts who receive a mailing or survey with the link.
 

5. To add a merge eld to the URL, click the Merge Field icon.
a. Select the database eld you want to merge. Merge elds are populated with data from the contact

record, account data or an associated incident, asset, opportunity, organization, or tracked link. You
can also use the special elds that are available. The value of this eld is appended to the URL as a
parameter. For example, if you wanted to pass the login eld value from the contact record, specifying
hp://www.global.example/regform.php?user=$contacts.login would return a URL such as hp://
www.global.example/regform.php?user=jsmith.

b. Click OK to append the eld to the URL.
6. To spell check the tracked link description, click Spelling on the ribbon.
7. Click Save.

The Save As window opens.
8. Select the folder you want to save the tracked link in and enter the name of the tracked link in the Name eld.
9. Click Save.

Add a File  
You can add les to your system that can be viewed by contacts who receive your mailings and surveys. After your les
are added, you can use them as many times as you want.

Links to the les can be inserted in documents, templates, and snippets as a link. As a best practice, always include
an unsubscribe link to give your contacts the option of opting out of future mailings and surveys. See Insert an
Unsubscribe Link.

Note:  Certain practical limitations exist that restrict the size of les that can be uploaded to Oracle Service
Cloud. See  Answer ID 280  on our support site.

1. Click Content Library on the navigation pane.
2. Double-click File Aachments Explorer.

The File Aachments explorer opens on the content pane.
3. Click New.

Tip:  You can also add les from an open le by clicking New. Additionally, if your navigation set
is congured to add les from the le menu, click  File > Content Library > File . See Overview of
Navigation Sets.

A new le opens on the content pane.
4. Enter eld information.
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Field Description

*File
 

Enter the full path name to the le you want to upload in this eld or click Browse to
browse for the le.
 
Click the text in this eld when editing a le to preview the le.
 

Menu Access Disabled
 

Select this check box to make the le unavailable. Sta members cannot select the le to
insert in a document.
 

End-User Access Disabled
 

Select this check box to make the le unavailable in mailings and surveys sent to
contacts. Contacts will receive a message indicating that access is denied.
 

Description
 

Enter a description of the le in this eld. The description is for internal use only. It is not
seen by contacts who receive a mailing or survey with the le.
 

5. To spell check the le description, click Spelling on the ribbon.
6. Click Save.

The Save As window opens.
7. Select the folder you want to save the le in and enter the name of the le in the Name eld.
8. Click Save.

How the HTML Editor Works  
When creating content for use in mailings, surveys, message templates, or answers, you can add HTML using an HTML
editor built into the system.

The HTML editor for answers is dierent from the HTML editor used for mailings, surveys, and message templates. The
information in this section pertains to the HTML editor for mailings, surveys, and message templates. For details about
the HTML editor for answers see HTML Editor for Answers.

The HTML editor contains many of the same options available in basic word processing applications and also has
specialized operations such as adding web forms, conditional sections, incident threads, merge elds, and merge reports.

You can create content in design or source mode. Using design mode, you can create dynamic, well-formaed content
even if you do not have previous HTML experience. You can include special formaing in your text and add graphics,
links, and other HTML features. You can also add links to existing content. See How You Add HTML in Design Mode.

Note:  For design mode to be available in Oracle RightNow Outreach Cloud Service (Outreach) and Oracle
RightNow Feedback Cloud Service (Feedback), the HTML Design Mode permission must be selected for both
Outreach and Feedback in your prole. See Outreach Permissions and Feedback Permissions.

Using source mode, you can create content using HTML source code. Regardless of which mode you use to create
content, you can preview how it appears to customers from the Preview tab.
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The links and dynamic content elements that display on the HTML editor are context-sensitive and depend on what
type of content you are creating.

Related Topics
• Links and Dynamic Content Elements

• Add HTML in Source Mode

• Preview Content

How You Add HTML in Design Mode  
Oracle Service Cloud contains an HTML editor for creating dynamic content.

When in design mode, you can use word processing functions to create HTML, as well as dynamic content, such as
adding a conditional section or a merge eld. You can add several types of links to your content as this image shows.
The links and dynamic content elements that display on the HTML editor are context-sensitive and depend on what
type of content you are creating.

Note:  For design mode to be available in Oracle RightNow Outreach Cloud Service (Outreach) and Oracle
RightNow Feedback Cloud Service (Feedback), the HTML Design Mode permission must be selected for both
Outreach and Feedback in your prole. Otherwise, only source mode is available. See Add HTML in Source
Mode, Outreach Permissions, and Feedback Permissions.

Links appear as clickable text when the document is used in a message, mailing, or survey or as a web page. When a
link is added, you have the option of dening certain aributes depending on the type of link. Links, as well as forms
and dynamic content elements, are located in the toolbox.

Tip:  You can dene style and class properties on most toolbox and tasks elements (or options) by right-
clicking the element after you add it to the canvas. Keep in mind that style and class must be dened in a
CSS le that is available on your web server and linked to in the <head> tag of a message, mailing, or survey
template. See Edit Style and Class.
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Using the toolbar, you can create HTML using many of the same options available in basic word processing applications.
Functions include:

• Cut, copy, and paste

• Find and replace text

• Print the document

• Undo and redo changes

• Switch to full screen

• Format text in numbered or bulleted lists

• Adjust indentation

• Center, left-justify, or right-justify text and images on the page

• Insert line breaks

• Change font size and style aributes (such as bold, italic, and underline)

• Apply special text formaing (such as color, highlighting, superscripts, and subscripts)

• Copy text formaing using the style applier

Additional functions are accessed through the Toolbox and Tasks sections. Within the Toolbox, there are HTML, Links,
and Dynamic Content sections. When creating documents in Outreach and Feedback, there is also a Forms section.
Within the Tasks, there are Start Over and Content sections. For detailed information about these functions, see the
Toolbox Section and Tasks Section tables here: Links and Dynamic Content Elements.

Tip:  You can insert HTML by clicking a buon in the Toolbox or Tasks section, or by dragging and dropping
the buon to a specic location on the canvas.

Links and Dynamic Content Elements  
You can add several types of links and dynamic content elements to your content. When an element is added, you have
the option of dening certain aributes depending on the type of element.

Links appear as clickable text when the content is used in a message, mailing, or survey. The tools that display on the
HTML editor are context sensitive and are the logical tools you would use for the specic content you are creating.

Links and dynamic content elements are found in the Toolbox and Tasks sections of the HTML editor. Within the
Toolbox, there are HTML, Links, and Dynamic Content sections. In Outreach and Feedback, there is also a Forms
section. Within the Tasks, there are Start Over and Content options.

Tip:  You can insert HTML by clicking a buon in the Toolbox or Tasks section, or by dragging and dropping
the buon to a specic location on the canvas.

Buon Description

HTML Buons in this section are used to insert standard HTML elements in your content.

Hyperlink
 

Click this buon to insert a hyperlink. See Insert a Hyperlink.
 

Image
 

Click this buon to insert an image. See Insert an Image.
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Buon Description

Horizontal Rule
 

Click this buon to insert a horizontal line.
 

Table
 

Click this buon to insert a table. See Insert a Table.
 

Div
 

Click this buon to insert a DIV block, which you can use to group other elements, such as buons.
 

Field Set
 

Click this buon to insert a eld set.
 

Buon
 

Click this buon to insert a buon. Double-click the buon on the canvas to edit the buon text.
 

Links Buons in this section are used to insert links in your content.

Note:  Some buons apply only to message templates and are noted as such.

Account Assistance Link
 

Click this buon to insert a link to the Account Assistance page on your customer portal. See Insert an
Account Assistance Link.
 

Agent Browser UI Incident Link
 

Inserts a link to the incident that triggered the sent message so that agents can access the incident
from the Agent Browser User Interface. See Insert an Agent Browser UI Incident Link.
 

Answer Link
 

Click this buon to insert a link to any answer you specify. See Insert an Answer Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Browser Link
 

Click this buon to insert a browser link. See Insert a Browser Link.
 

Chat Link
 

Click this buon to insert a link to the Live Help page on the customer portal. See Insert a Chat Link.
 
This buon is available only if Oracle RightNow Chat Cloud Service (Chat) is enabled.
 

Cloud Link
 

Click this buon to insert a link to a social media service. See Insert a Cloud Link.
 

Customer Portal Incident Link
 

Click this buon to insert a link to the incident that triggered the sent message. For example, the
standard Question Receipt email sends a conrmation message after a customer submits a question
through the Ask a Question page, an email, or a chat session. By adding a Customer Portal Incident
Link to your Question Receipt message template, you can provide your customers with easy access to
the incident created from their question. See Insert a Customer Portal Incident Link.
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Buon Description

File Link
 

Click this buon to insert a le link. See Insert a File Link.
 

Forward to Friend Link
 

Click this buon to insert a forward to friend link. See Insert a Forward to Friend Link.
 

Incident Link
 

Click this buon to insert a link to any incident you specify. See Insert an Incident Link.
 

Prole Link
 

Click this buon to insert a link to the Account Seings page on your customer portal. See Insert a
Prole Link.
 

Proof Comments Link
 

Click this buon to add more than one comment eld to the Survey Proof message template that is
sent to proofreaders of website link surveys. See Insert a Proof Comments Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Proof Survey Link
 

This buon is included, by default, on the Survey Proof message template and links to the website link
survey you want your proofreaders to review. See Insert a Proof Survey Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Reset Password
 

Click this buon to insert a reset password link. See Insert a Reset Password Link.
 

Setup Password
 

Click this buon to insert a link to the Finish Account Creation page on your customer portal. See Insert
a Setup Password Link.
 

Survey Link
 

Click this buon to insert a link to a survey. See Insert a Survey Link.
 

Survey Results Link
 

This buon is included, by default, on the Survey Notication message template and links to a web
page that shows the survey responses. See Insert a Survey Results Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

This Answer Link
 

Click this buon to insert a link to the incident that triggered the sent message. See Insert a This
Answer Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

This Discussion Link
 

Click this buon to insert a link to the email discussion that triggered the sent message. See Insert a
This Discussion Link.
 
This buon is available only in message templates. See How You Customize Messages.
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Buon Description

 

Tracked Link
 

Click this buon to insert a tracked link. See Insert a Tracked Link.
 

Unsubscribe All Answers Link
 

Click this buon to insert a link that lets contacts who receive answer notications unsubscribe from
future communications. See Insert an Unsubscribe All Answers Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Unsubscribe Link
 

Click this buon to insert an unsubscribe link. See Insert an Unsubscribe Link.
 

Unsubscribe This Answer Link
 

Click this buon to insert an unsubscribe link to a specic answer that’s been returned as the result of a
repeatable answer section. See Insert an Unsubscribe This Answer Link.
 
This buon is available only on the Answer Update Notication message template. See How You
Customize Messages.
 

View Subscriptions Link
 

Click this buon to insert a link customers can use to edit the list of social notications they are
subscribed to. See Insert a View Subscriptions Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Web Page Link
 

Click this buon to insert a web page link. See Insert a Web Page Link.
 

Forms Buons in this section are used to insert web forms and survey questions in your HTML. These buons
are available only for documents, templates, and snippets created in Outreach and Feedback. See
Insert a Web Form.

Web Form
 

Click this buon to insert a web form to collect customer data. Documents can contain only one web
form.
 

Form Field
 

Click this buon to insert a database eld in the web form. Your web form must contain at least one
form eld.
 

Survey Question
 

Click this buon to insert a survey question in the web form.
 

Submit Buon
 

Click this buon to insert a buon for submiing the web form.
 

Dynamic Content Buons in this section are used to insert dynamic content in your HTML.

Answer Section
 

Click this buon to add any repeatable answer details on your answer update notication messages.
See Insert an Answer Section.
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Buon Description

 
This buon is available only in message templates. See How You Customize Messages.
 

Case Section
 

Click this buon to add a case section to your conditional text. See Insert a Case Section.
 

Conditional Section
 

Click this buon to insert a section of conditional text. See Insert a Conditional Section.
 

Content Placeholder
 

Click this buon to add a content placeholder to your template. When you create a template by
uploading an HTML le, you must add a content placeholder because templates cannot be saved
without a content placeholder. See Create a Template.
 
This buon is available only for templates. For message templates, this buon displays in the HTML
section of the toolbox.
 

Incident Thread
 

Click this buon to insert an incident thread that displays all communication between the parties
associated with the message. See Insert an Incident Thread.
 

Merge Field
 

Click this buon to insert a merge eld. See Insert a Text Merge Field.
 

Merge Report
 

Click this buon to insert a merge report. See How Merge Reports Work.
 

Buon Description

Start Over Buons in this section are used to clear all HTML content and start over.

Use Existing
 

Click this buon to clear all HTML elements and start over with an existing document.
 

Upload HTML
 

Click this buon to clear all HTML elements and start over with content uploaded from an HTML le.
 

Content Buons in this section are used to insert snippets and symbols and manage HTML anchors.

Apply Template
 

Click this buon to select a template to apply to a document. You cannot apply a template to templates
or snippets. See Create a Template.
 
After a template has been applied to a document, it can be cleared by clicking the Apply Template
buon, then clicking the Clear Template buon on the Choose Template window.
 

Insert Snippet
 

Click this buon to insert a snippet. See Create a Snippet.
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Buon Description

Insert Symbol
 

Click this buon to insert a special symbol. A symbol map opens. Double-click the symbol you want to
insert.
 

Insert Address
 

Click this buon to insert a physical address. See Insert a Physical Address.
 

Note:  The CAN-SPAM Act of 2003 requires that commercial email messages contain the
sender’s valid physical postal address.

Manage Anchors
 

Click this buon to add or remove an anchor or go to an anchored site. See Insert an Anchor.
 

Test CAN-SPAM
 

Click this buon to test the document for CAN-SPAM compliance. See CAN-SPAM Compliance.
 
This buon is available only when editing a document in a mailing message or survey invitation
message.
 

Add HTML in Source Mode  
The HTML editor contains an option to create your documents using HTML code. You can enter HTML code directly in
the editor to create your content.

The editor displays your code using colored text to indicate structure and syntax. There are additional functions
available that you can access through the Toolbox and Tasks sections. The links and dynamic content elements that
display on the HTML editor are context-sensitive and depend on what type of content you are creating. When you save,
the system automatically validates your code formaing and noties you about any errors.

Note:  By default, the editor requires your code to be XHTML compliant before it can be saved. To allow code
to be saved without XHTML compliance, disable the HTML_TIDY_ENFORCE_XHTML conguration seing
(RightNow User Interface/Misc. Customization/HTML Editor).

1. Click the Source tab at the boom of the HTML editor.

Source mode automatically places the cursor after the opening <body> tag. This image shows the HTML editor
in source mode with the HTML tab selected.
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The Source tab has a toolbar and a section for entering your source code. Using the toolbar, you can create
HTML using some of the same options available in basic word processing applications. Functions include:

◦ Cut, copy, and paste

◦ Find and replace text

◦ Print the document

◦ Undo and redo changes

◦ Switch to full screen

◦ Enable or disable syntax highlighting

Tip:  It’s a good idea to preview your work when using Source mode. When you switch between the
Source and Preview tabs, your cursor stays where you left it, making it easy to check your work. See
Preview Content.

Additional functions are accessed through the Toolbox and Tasks sections. You can insert HTML by clicking
a buon in the Toolbox or Tasks section, or by dragging and dropping the buon to a specic location on the
canvas. For detailed information about these functions, see the Toolbox Section and Tasks Section tables in
Links and Dynamic Content Elements.

How You Can Use Dynamic Content  
In addition to HTML, Oracle Service Cloud supports the passing of specic JavaScript events to elds within web forms
and surveys. This provides increased exibility in personalizing the appearance and behavior of elds and questions as
they are completed.

For example, an “onclick” event can be specied to dynamically enable a phone number eld when a customer selects a
check box indicating they want to be contacted by phone.

Event Field Types

onselect
 

Text elds such as email, rst_name, last_name, or any custom eld of type text eld, text area, or
integer.
 

onchange
 

• Text elds such as email, rst_name, last_name, or any custom eld of type text eld, text area, or
integer.
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Event Field Types

• Drop-down menus such as country, province, or any custom eld of type menu, date, or date
time.

onblur
 

• Text elds such as email, rst_name, last_name, or any custom eld of type text eld, text area, or
integer.

• Drop-down menus such as country, province, or any custom eld of type menu, date, or date
time.

• Options and check boxes such as opt-in elds, or any custom eld of type opt-in or yes/no.

onfocus
 

• Text elds such as email, rst_name, last_name, or any custom eld of type text eld, text area, or
integer.

• Drop-down menus such as country, province, or any custom eld of type menu, date, or date
time.

• Options and check boxes such as opt-in elds, or any custom eld of type opt-in or yes/no.

onclick
 

• Text elds such as email, rst_name, last_name, or any custom eld of type text eld, text area, or
integer.

• Drop-down menus such as country, province, or any custom eld of type menu, date, or date
time.

• Options and check boxes such as opt-in elds, or any custom eld of type opt-in or yes/no.

disabled
 

Text elds such as email, rst_name, last_name, or any custom eld of type text eld, text area, or
integer.
 

How You Create and Edit Text-Only Messages  
You can create text-only messages for your customers who can receive only plain text emails.

Unlike the HTML editor, the text editor does not contain text formaing options. It does, however, contain links for
additional functions related to Oracle Service Cloud, such as adding a merge eld, or conditional section. You can also
add several types of links to your content. When a link is added, you have the option of dening certain aributes
depending on the type of link. Links in plain text cannot be clicked and customers need to copy the URL into their web
browser.

Using the toolbar, you can use several of the same options available in basic word processing applications. Functions
include:

• Cut, copy, and paste

• Find and replace text

• Print the document

• Undo and redo changes

• Switch to full screen

• Enable or disable syntax highlighting

Additional functions are accessed through the Toolbox and Tasks sections.
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Buon Description

Links Buons in this section are used to insert links in your content.

Account Assistance Link
 

Click this buon to insert a link to the Account Assistance page on your customer portal. See Insert an
Account Assistance Link.
 

Agent Browser UI Incident Link
 

Inserts a link to the incident that triggered the sent message so that agents can access the incident
from the Agent Browser User Interface. See Insert an Agent Browser UI Incident Link.
 

Answer Link
 

Click this buon to insert a link to any answer you specify. See Insert an Answer Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Browser Link
 

Click this buon to insert a browser link. See Insert a Browser Link.
 

Chat Link
 

Click this buon to insert a link to the Live Help page on the customer portal. See Insert a Chat Link.
 
This buon is available only if Chat is enabled.
 

Cloud Link
 

Click this buon to insert a link to a social media service. See Insert a Cloud Link.
 

Customer Portal Incident Link
 

Click this buon to insert a link to the incident that triggered the sent message. For example, the
standard Question Receipt email sends a conrmation message after a customer submits a question
through the Ask a Question page, an email, or a chat session. By adding a Customer Portal Incident
Link to your Question Receipt message template, you can provide your customers with easy access to
the incident created from their question. See Insert a Customer Portal Incident Link.
 

File Link
 

Click this buon to insert a le link. See Insert a File Link.
 

Forward to Friend Link
 

Click this buon to insert a forward to friend link. See Insert a Forward to Friend Link.
 

Incident Link
 

Click this buon to insert a link to any incident you specify. See Insert an Incident Link.
 

Prole Link
 

Click this buon to insert a link to the Account Seings page on your customer portal. See Insert a
Prole Link.
 

Reset Password
 

Click this buon to insert a reset password link. See Insert a Reset Password Link.
 

Setup Password
 

Click this buon to insert a link to the Finish Account Creation page on your customer portal. See Insert
a Setup Password Link.
 

Survey Link
 

Click this buon to insert a link to an existing survey. See Insert a Survey Link.
 

This Answer Link
 

Click this buon to insert a link to the incident that triggered the sent message. See Insert a This
Answer Link.
 

This Discussion Link
 

Click this buon to insert a link to the email discussion that triggered the sent message. See Insert a
This Discussion Link.
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Buon Description

 
This buon is available only in message templates. See How You Customize Messages.
 

Tracked Link
 

Click this buon to insert a tracked link. See Insert a Tracked Link.
 

Unsubscribe All Answers Link
 

Click this buon to insert a link that lets contacts who receive answer notications unsubscribe from
future communications. See Insert an Unsubscribe All Answers Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Unsubscribe Link
 

Click this buon to insert an unsubscribe link. See Insert an Unsubscribe Link.
 

Unsubscribe This Answer Link
 

Click this buon to insert an unsubscribe link to a specic answer that’s been returned as the result of a
repeatable answer section. See Insert an Unsubscribe This Answer Link.
 
This buon is available only on the Answer Update Notication message template. See How You
Customize Messages.
 

View Subscriptions Link
 

Click this buon to insert a link customers can use to update the list of social notications they are
subscribed to. See Insert a View Subscriptions Link.
 
This buon is available only in message templates. See How You Customize Messages.
 

Web Page Link
 

Click this buon to insert a web page link. See Insert a Web Page Link.
 

Dynamic Content Buons in this section are used to insert dynamic content.

Answer Section
 

Click this buon to add any repeatable answer details on your answer update notication messages.
See Insert an Answer Section.
 
This buon is available only in message templates. See How You Customize Messages.
 

Case Section
 

Click this buon to add a case section to your conditional text. See Insert a Case Section.
 

Conditional Section
 

Click this buon to insert a section of conditional text. See Insert a Conditional Section.
 

Incident Thread
 

Click this buon to insert an incident thread that displays all communication between the parties
associated with the message. See Insert an Incident Thread.
 

Merge Field
 

Click this buon to insert a merge eld. See Insert a Text Merge Field.
 

Merge Report
 

Click this buon to insert a merge report. See Merge a Report into Content.
 

Start Over Buons in this section are used to clear all content and start over.

Use Existing
 

Click this buon to clear all content and start over with an existing document.
 

Convert HTML
 

Click this buon to clear all text and start over with a converted HTML le. See Create Text Content in
Documents.
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Buon Description

 

Content Buons in this section are used to insert snippets and symbols.

Insert Snippet
 

Click this buon to insert a snippet. See Create a Snippet.
 

Insert Symbol
 

Click this buon to insert a special symbol. A symbol map opens. Double-click the symbol you want to
insert.
 

Insert Address
 

Click this buon to insert a physical address. See Insert a Physical Address.
 

Note:  The CAN-SPAM Act of 2003 requires that commercial email messages contain the
sender’s valid physical postal address.

Preview Content  
You can preview the HTML and text versions of your content. The content displays as customers will see it in their email
client or on a web page.

1. Click the Preview tab at the boom of the HTML editor.
2. To see how your dynamic content displays, either by incident or contact, click the Search icon next to the

Preview Incident or Preview Contact eld.

The Search window opens where you can search for an incident or a contact to use when the message is
previewed on the Preview tab.

Prell Web Form Fields  
Web forms can display with one or more elds prelled with data, leing you simplify the form completion process for
your contacts.

By appending specially formaed parameters to the web page URL, any database or custom contact eld that appears
on the form can be set with a default value. Field values submied in a prelled form overwrite the existing values in the
contact record. Prelled values can be unique to the placement of each link. For example, you can publish links at three
dierent sites to a single web form but congure each link to prell elds on the form with dierent values.

To prell elds in a web form, the document containing the form must rst be served in a campaign or advanced survey
using a Serve Web Page element. See Edit Serve Web Page Aributes.

1. Open the campaign or survey that serves the document containing the web form.
2. Double-click the Serve Web Page element to open the Serve Web Page window.
3. To prell the web form with any eld information that can be derived from a contact’s Oracle Service Cloud

browser cookie, click the User Identication tab.
a. Select Other Credentials.
b. Select the Cookie check box to enable browser cookie identication.

Note:  Prelled eld values override any common values set by the cookie.

c. Select the Email Click-Through Parameters check box to enable parameters passed in the URL.
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4. Click the Web Page tab and click Copy URL.
a. Click OK to acknowledge that the web page URL has been copied to the clipboard.

5. Click OK to close the window.
6. If you have not already launched the campaign or survey, click Launch on the Home tab.

a. Click OK to launch and save.
7. Open a new web browser and paste the web page URL into the browser address eld.
8. Append parameters to the URL to dene which elds you want to prell. See How You Append Field Parameters.

a. Submit the URL in your web browser and conrm the elds are prelled as you want.
9. Copy the updated URL from the browser address eld and publish the link to your designated external sources.

Related Topics
• Insert a Web Form

How You Append Field Parameters  
Every eld in a web form is associated with a parameter that can be passed a value in the web page URL, and multiple
parameters may be passed at the same time to dene multiple eld values.

To dene a prelled value for a specic eld, append its parameter to the web page URL in the following format:

 /wf_2_<field_ID>/<prefill value>

Each eld parameter contains a unique eld ID. You can view custom eld IDs on the Custom Fields editor by hovering
over each eld. For example, if a custom eld has an ID of 3, the parameter would be:

 /wf_2_3/<prefill value>

Default contact elds also have unique eld IDs. For example, if you select the Country eld, which has an ID of 100022,
the parameter would be:

 /wf_2_100022/<prefill value>

Field Name Field Field ID

Last Name
 

last_name
 

100002
 

First Name
 

rst_name
 

100003
 

Email Address
 

email
 

100004
 

Email Address Alternate 1
 

email_alt1
 

100010
 

Email Address Alternate 2
 

email_alt2
 

100011
 

Title
 

title
 

100013
 

Oce Phone
 

ph_oce
 

100015
 

Mobile Phone
 

ph_mobile
 

100016
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Field Name Field Field ID

Fax Phone
 

ph_fax
 

100017
 

Assistant Phone
 

ph_asst
 

100018
 

Home Phone
 

ph_home
 

100019
 

Street
 

street
 

100020
 

Country
 

country_id
 

100022
 

State/Province
 

prov_id
 

100023
 

Postal Code
 

postal_code
 

100024
 

Global Opt-in
 

ma_opt_in
 

100025
 

Organization Name (Outreach)
 

ma_org_name
 

100027
 

Invalid Email Flag
 

email_invalid
 

100028
 

Email Format Preference
 

ma_mail_type
 

100029
 

Organization Name Alternate
(Outreach)
 

ma_alt_org_name
 

100051
 

Last Name Alternate
 

alt_last_name
 

100052
 

First Name Alternate
 

alt_rst_name
 

100053
 

Survey Opt-In
 

survey_opt_in
 

100054
 

Note:  For descriptions of these elds, click Conguration on the navigation pane, expand Database, and
then double-click Data Dictionary.

The prell values that can be passed in a parameter depend on the eld type. All database contact elds and contact
custom elds are one of the following types.

• Text Field or Text Area—The value of a text eld or text area is expressed in the URL as text. Append the text
you want as the value of the eld, and the eld prells with that text. For example, to prell the Postal Code eld
with the text “59771,” append that value to the eld parameter as follows:
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 /wf_2_100024/59771

• Integer—The value of an integer eld is expressed in the URL as an integer. Append the integer you want as the
value of the eld, and the eld prells with that integer. For example, to prell a custom eld (ID 301) with the
number “5,” append that value to the eld parameter as follows:

 /wf_2_301/5

• Menu—The value of a menu eld item is expressed in the URL as a unique ID number. (Menu item IDs can be
obtained by viewing the source code of the form in a web browser.) Append the ID of the menu item to prell
the eld with the text of that menu item. For example, to prell the State/Province eld with “MT,” append its
menu item ID value to the eld parameter as follows:

 /wf_2_100023/32

• Radio or Opt-in—The value of a radio or opt-in eld is expressed in the URL as 0 for a “No” value or 1 for a “Yes”
value. Append either 0 or 1 and the No or Yes radio buon will be selected. For example, to select the Yes radio
buon on the Global Opt-in eld, append “1” to the eld parameter as follows:

 /wf_2_100025/1

• Date or Date/Time—The value of a date or date/time eld is expressed in the URL in a special time format.
Append the formaed value to prell the eld with the equivalent date or date/time. Use the following formats
to pass values to date and date/time elds:

 <Year>-<Month>-<Day>T
 <Year>-<Month>-<Day>T<hour>:<minute>

For example, to prell a custom date eld (ID 320) with the date “November 1, 2005,” append “2005-11-01T” to the eld
parameter as follows:

 /wf_2_320/2005-11-01T

Or, to prell a custom date/time eld (ID 320) with the date and time “November 1, 2005, 3:32 PM,” append
“2005-11-01T15:32” to the eld parameter as follows:

 /wf_2_320/2005-11-01T15:32 

Note:  Remember to include the “T” after the date when declaring a value in date or date/time format.

You can prell multiple elds on a form at the same time by appending multiple parameters to a single URL, separated
by slashes. This image shows a URL that has been modied to prell three elds: State, Country, and a service provider
custom eld.
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To prell these elds, the following three parameters were added to the end of the URL:

• /wf_2_100023/32—The State eld is assigned the numeric ID value of 32 for the menu option “Montana.”

• /wf_2_100022/1—The Country eld is assigned the numeric ID value of 1 for the menu option “U.S.”

• /wf_2_3/985—The custom service provider eld is assigned the numeric ID value of 985 for the menu option
“Technicomm.”

Web Form and Survey Security  
When customers submit information to websites, it is common to verify the information originates from a human rather
than a bot (an automated software program) being run for malicious purposes.

Oracle Service Cloud provides web form and survey security that automatically requires human validation when abuse is
suspected. For example, when a standard action is performed repeatedly in a short amount of time.

Validation is accomplished through the use of a CAPTCHA, a dialog containing distorted words that the customer is
asked to type. When the words are typed correctly, a human is assumed to be on the client side. After customers have
correctly entered a CAPTCHA, they are not asked for verication again as long as the visit has not ended or does not
exceed an hour.

Note:  Because CAPTCHA runs behind the scenes, it is presented to the customer only when a web form or
survey displays and requires the customer to type data and submit it to the system.
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External Supression List  

Overview of the External Suppression List  
In addition to the global suppression list applied across all Oracle Service Cloud sites, you can use the external
suppression list to dene a site-specic list of email addresses that are excluded from mailings and surveys.

When a mailing or survey is sent or launched, the audience is automatically checked against both the global and
external suppression lists and email is not sent to contacts with an email address on either list. This can help you ensure
that certain addresses are consistently excluded from marketing and survey communications even if those contacts
have not explicitly opted out.

Note:  The global suppression list supplements your site-specic external suppression list to exclude a list of
known SPAM addresses and invalid (or mis-typed) domains. Although the external suppression list is honored
by default, you can congure individual surveys and mailings to ignore the external suppression list and send
to all audience members instead. Keep in mind that the global suppression list is always honored. See Dene
the Broadcast Mailing Audience and Dene the Broadcast Survey Audience.

Create or Edit an External Suppression List  
You can create the external suppression list by adding email addresses individually or uploading a list of multiple
addresses from a le.

You can also replace the current list with a new list or remove specic email addresses from the suppression list if you
decide you now want to send mailings or surveys to those addresses.

Note:  The list of email addresses you use to append to the existing external suppression list or to replace it
must be a .txt document with a separate email address on each line.

The following procedure assumes that the External Suppression List component has been added to your navigation list.

1. Click Conguration on the navigation pane.
2. Expand Outreach, and then double-click External Suppression List.

The External Suppression List editor displays on the content pane.
3. To append a list of addresses to the external suppression list, click Append to List on the ribbon. A window

opens to let you browse to the folder that contains the le you want to append.

Note:  Practical limitations can cause the upload process to time out after ve minutes. If you have
diculty uploading a large le, split the data into multiple les and upload them instead. For more
about le size limitations, see  Answer ID 280  on our support site.

a. Select the .txt le you want to append or type its path and name in the File Name eld.
b. Click Open.

A message lets you know that the upload was successful.
c. Click OK.
d. Click the Search icon to the right of the Search the External Suppression List eld.

The email addresses in the le display in the Records Found section.
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4. To add an individual email address to the external suppression list, enter the email address in the Add to the
External Suppression List.

a. Click the Add Email icon to the right of the eld.
b. Click the Search icon to the right of the Search the External Suppression List eld.

The new email address displays in the Records Found section.
5. To replace the existing suppression list with a dierent list, click Replace List on the ribbon. A window opens to

let you browse to the folder that contains the le you want to replace the list with.
a. Select the .txt le you want to replace the existing list or type its path and name in the File Name eld.
b. Click Open. A message asks you to conrm that you want to replace the list.
c. Click Yes to conrm.
d. Click the Search icon to the right of the Search the External Suppression List eld.

The Records Found section now displays only the email addresses in the le you selected.
6. To delete individual email addresses in the external suppression list, search for the addresses you want to

delete. See Search the External Suppression List.
a. Select the check box next to each email address you want to delete.
b. Click Delete on the ribbon. A message asks you to conrm that you want to delete the selected

addresses.
c. Click Yes to conrm.

The Records Found section is refreshed to remove the addresses you deleted.
7. To delete all email addresses in the external suppression list, click  Delete All on the ribbon. A message asks

you to conrm.
a. Click Yes to conrm.

A message lets you know all email addresses were successfully deleted.
b. Click OK.

Search the External Suppression List  
Before you can remove individual email addresses from the external suppression list, you need to select them, which
means you must display them on the editor by searching for them. You might, for example, want to search for and
delete all email addresses with a specic domain.

1. Click Conguration on the navigation pane.
2. Expand Outreach, and then double-click External Suppression List.

The editor displays on the content pane.
3. Select the type of search you want from the Like drop-down menu.

Search Option Description

Like The search returns email addresses that contain the search term you enter. For
example, typing and returns the following results: jim.anderson@example.com, sandy_
johnson@example.net, and jsmith@example.net.

Ends With The search returns email addresses that end with the search term you enter. Use this
option to nd all email addresses at a specic domain, such as example.com.

Exact Match The search returns email addresses that exactly match the search term you enter.

Starts With The search returns email addresses that begin with the search term you enter.

4. Enter your search term in the text eld. Leave this eld blank to return all email addresses in the list.
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5. Click Search icon.
The number of matching records and the returned email addresses display in the Records Found section.

6. To select one or more email addresses to remove from the external suppression list, do one of the following:

◦ Select the check box next to each email address.

◦ Select the Select All check box if you want to remove all of the addresses in the Records Found eld.

Download the External Suppression List  
You can download your external suppression list and save it to a text le on your local workstation.

1. Click Conguration on the navigation pane.
2. Expand Outreach, and then double-click External Suppression List.

The editor displays on the content pane.
3. Click Download List on the ribbon.

A window opens where you can browse to the folder where you want to save the le.
4. Enter the le name in the File Name eld or select an existing le to overwrite it.
5. Click Save.

A conrmation message lets you know the download was successful and asks if you want to open the le.
6. Click Yes or No to close the download conrmation.

If you click Yes, the le opens.

Outreach Mailings  

Overview of Mailings  
Oracle RightNow Outreach Cloud Service (Outreach) provides a centralized, intuitive method of sending emails to
specic audiences.

You can create messages using text and HTML documents, and choose contact lists and segments to be included in or
excluded from the mailing. Mailings can then be sent all at the same time or at dierent times determined by specic
criteria or transactional events.

Outreach also provides extensive tools for proong and testing mailings. You can send mailings to one or more people
for approval and track the status of their review. You can also send mailings to smaller subsets of the dened audience
and view analytics regarding how many emails sent to the subset bounced or were opened, clicked though, replied to,
or unsubscribed to. This lets you ne-tune the mailing before broadcasting it to the entire audience, and also lets you
determine how eective it was after the entire broadcast.

Related Topics
• Overview of Audiences

• Overview of Content Library

• Dene the Broadcast Mailing Audience

• Dene the Transactional Mailing Audience
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How Mailings Work  
You can target and email dierent groups of your customers. When you create a mailing, you dene the content of the
message and the group of customers who will receive it.

You can include and exclude a total of fty contact lists or segments of contacts from your mailing. You can also send
test mailings and proofs before commiing to a nal email.

There are two types of mailings you can create, distinguished by delivery method.

• Broadcast mailings are used to send a message to a specied audience at a time you choose.

• Transactional mailings are event-triggered, so the email is sent when actions you dene occur, such as a
campaign action or a rule action.

This owchart shows how the processes for creating and sending a broadcast mailing are dierent from a transactional
mailing.
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Note:  The following procedure assumes that you access the Mailings explorer from the Mailings navigation
list. However, this explorer may reside in a dierent navigation list.

1. Click Mailings on the navigation pane and double-click Mailings Explorer.
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The Mailings explorer opens on the content pane.
2. Click New.

A new mailing opens on the content pane.

Tip:  You can also create a mailing from an open mailing by clicking New. Additionally, if your
navigation set is congured to add mailings from the le menu, click  File > Mailing . See Overview of
Navigation Sets.

3. To create a broadcast mailing (the mailing method selected by default), see Create a Broadcast Mailing.
4. To change to a transactional mailing, see Change the Mailing Method. Then, to create the transactional mailing,

see Create a Transactional Mailing.

Related Topics
• Overview of Audiences

• Overview of Content Library

• Dene the Broadcast Mailing Audience

Mailing Delivery Statuses  
Delivery status indicates the current state of the mailing as it progresses through the distribution process.

Your broadcast and transactional mailings must follow certain steps that are dened by the mailing delivery status.

This table describes the delivery statuses for broadcast and transactional mailings and indicates whether the status is
set by a sta member action or updated automatically by the system.

Status Survey Type Description

Draft
 

Broadcast
Transactional
 

This is the preliminary status of a mailing. When a mailing is created, it is
automatically set to the Draft status. The status reverts to Draft if a sta member
unschedules the mailing.
 

Scheduled
 

Broadcast
 

This status indicates a mailing is ready to be sent at a scheduled date and time.
When a sta member selects the send time, the mailing is automatically set to
the Scheduled status.
 

Launched
 

Transactional
 

This status indicates a mailing has been launched and can be included in a rule
or campaign. Sta members launch a mailing by clicking the Launch on the
Delivery tab.
 
A launched mailing cannot be edited. However, you can suspend the mailing
message, make edits, and then re-launch it. See Suspend a Transactional Mailing.
 

Recurrence Scheduled
 

Broadcast
 

This status indicates a mailing is scheduled for recurring runs. When a sta
member selects a recurrence paern, the mailing is automatically set to the
Recurrence Scheduled status.
 

Preparing to Send
 

Broadcast
 

This status indicates a mailing is about to be sent. The status changes to
Preparing to Send when a sta member clicks Send Now.
 

Sending
 

Broadcast
 

This status indicates a mailing is currently being sent to customers. The system
automatically sets the mailing status to Sending after the mailing is done
preparing to send or at the date and time the mailing is scheduled to send.
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Status Survey Type Description

 

Suspended
 

Broadcast
Transactional
 

This status indicates a mailing is temporarily suspended from the Sending or
Scheduled status. Sta members can change the status to Suspended by clicking
Suspend on the Delivery tab.
 

Suspended by Error
 

Broadcast
Transactional
 

This status indicates a mailing encountered an error and was suspended by the
system.
 

Canceled
 

Broadcast
Transactional
 

This status indicates the survey was manually canceled. Sta members can
cancel a mailing by clicking Cancel Mailing on the Delivery tab.
 
A canceled mailing can no longer be modied or sent. However, it can be copied
to a new mailing, and the copy can be modied and sent.
 

Completed
 

Broadcast
 

This status indicates a mailing was sent. The system automatically sets a mailing
status to Completed from the Sending status.
 

Related Topics
• Access Broadcast Mailing Delivery Options

• Access Transactional Delivery Options for Mailings

Mailing Management  
When creating or editing a mailing, the Summary tab provides a variety of mailing management functions, including
changing the mailing method, adding notes, and adding tasks.

• Changing the mailing method—Once you create a mailing, you can change its mailing method type. The
mailing methods available are Broadcast and Transactional. Broadcast mailings with recurrence activated are
shown as Recurring Broadcast.

• Adding notes—You may want to add notes to a mailing that are not sent to audience members. You can use
notes to provide additional information about the mailing that can be viewed by sta members as they are
working with the mailing.

• Adding tasks—You can assign new or existing tasks to mailings and edit, delete, and forward tasks to other
sta members. You can also view each task associated with the mailing.

Other common functions available from the Summary tab include the ability to add le aachments or view the audit
log to see when the mailings were created and edited and when mailing delivery statuses were changed.

Related Topics
• Overview of Standard Workspaces

Change the Mailing Method  
After you create a mailing, you can change its mailing method type.

You can switch mailing methods only when the delivery status of the mailing is Draft, Suspended, or Error and no emails
have been sent. See Mailing Delivery Statuses.

1. On the Summary tab of an open mailing, click Change next to Mailing Method.
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The Select Mailing Method window opens.
2. Select Broadcast or Transactional.
3. Click OK.

The mailing changes to the method you selected.

Add a Note to a Document, Mailing, or Survey  
You can use notes to provide additional information about the content that can be viewed by sta members as they are
working with the document, mailing or survey.

1. On the Summary tab of an open document, mailing, or survey, click the Notes tab.
2. Click Add.
3. Enter the note text in the text eld.
4. To sort the notes by ascending or descending date, click the Sort drop-down menu and select the sort option.
5. To edit an existing note, click Edit next to the note.
6. To permanently delete a note, click Delete next to the note.

Add a Task to a Mailing  
You can assign new or existing tasks to mailings and edit, delete, and forward tasks to other sta members. You can also
view each task associated with the mailing.

1. On the Summary tab of an open mailing, click the Tasks tab.
2. Enter eld information.

Buon Description

Add Click this buon to display a drop-down menu containing the following options.
 

Add New Select this option to add a task.

Add Existing Select this option to add an existing task. After nding and selecting a task, the task is
added to the task list for the mailing.

Open Click this buon to open the selected task for editing.
 

Print Click this buon to print the task.
 

Copy Click this buon to copy the task.
 

Delete Click this buon to permanently delete the task.
 

Remove Click this buon to remove the selected task from the mailing (without deleting the
task).
 

Complete Click this buon to mark the task completed.
 

Forward Click this buon to send the task to one or more recipients.
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Buon Description

 

Options Click this buon to select an option for managing the output and display of information
on the tab, such as print, forward, or export. See How You Change Report Formaing for
information about other options, such as Auto Filter, Slice, Cross Tab, and Rollups.

Related Topics
• Overview of Common Functionality

• Add a Task

• Search for a Task from an Open Record

Create a Broadcast Mailing  
You can create a broadcast mailing if you want to email a group of contacts in your knowledge base. Broadcast mailings
are sent to an audience you dene.

The content of the email can be added as you create the mailing, or by using a previously dened document. See Create
a Document. You can also choose to market test your mailing by sending dierent message content to subsections of
your audience.

Note:  The delivery of broadcast mailings can be impaired by factors beyond the scope of Outreach. Contact
your account manager for steps you can take to optimize your message delivery and to improve delivery and
participation rates.

1. From the Mailings explorer, click New.
A new broadcast mailing opens on the content pane.
By default, the Summary tab is active. From here, you can review general information about the mailing in the
At a Glance section, as well as manage mailing notes, tasks, and aachments. As you create the mailing, you
move through each tab to complete the mailing elements.

Note:  You can also add custom tabs to your mailings. Custom tabs give you quick access to elements
you frequently use in your mailings. See Add a Custom Tab to Mailings.

2. To assign the mailing to another sta member (by default, the mailing is assigned to the sta member who
creates it), click the Assigned drop-down menu and select the sta member.

Tip:  Wildcards are supported when searching sta members. You can search strings that include
a space by entering %+Space+character, which is helpful when searching last names. For example,
entering %+Space+b returns all last names starting with the leer b. There is also an implied wildcard
when searching, so entering b in the Find eld returns all items containing the leer b.

a. To search for a sta member, enter the sta member’s name in the Find eld.
3. Click the calendar in the Planned Launch eld to select a date for the launch.

This eld is for planning purposes only. The email is not sent on this date.
4. Click the links in the At a Glance section to perform common mailing functions.
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Field Description

Mailing Method
 

This eld displays the mailing method currently selected for the mailing. Click Change to
change the method. See Mailing Management.
 

Market Testing
 

This eld displays the market testing mode of the mailing. Click Change to change
market testing modes. See Activate Market Testing in Broadcast Mailings.
 

Audience Count
 

This eld displays the most recent audience count and the time and date it was
performed. Click Refresh to perform an updated count. To view the details of the count,
 click Details. See View Audience Count Details in Mailings.
 

Message
 

Click Preview to preview the mailing.
 

Proong
 

This eld displays the cumulative number of proofs that have been sent, approved, and
rejected. Click Send Proof Message to send a proof. See Send a Proof.
 

Delivery Status
 

This eld displays the delivery status of the mailing and the number of emails sent and
delivered. See Access Broadcast Mailing Delivery Options.
 

5. Click the Audience tab to dene an audience for the mailing.
6. Click the Message tab to create the email sent to the mailing audience. See Create a Message in Broadcast

Mailings.
7. Click the Proong tab to send a proof of the mailing for internal review before sending it to the entire audience.
8. Click the Delivery tab to select delivery options.
9. Click the Results tab to view the report associated with the mailing. See View Mailing Results.

Note:  If your application is congured with custom tabs for mailings, they display after the Results
tab.

10. To spell check the mailing, click Spelling.
11. Click Save.

The Save As window opens.
12. Select the folder you want to save the mailing in and enter the name of the mailing in the Name eld.
13. Click Save.

Dene the Broadcast Mailing Audience  
You specify the audience your broadcast mailing will be sent to from the Audience tab.

You can include and exclude a total of fty contact lists and segments, each containing a vast number of contacts. For
example, you could include twenty-two segments of contacts and exclude twenty-eight contact lists for a total of fty
lists. You can also restrict the scope of your audience, set mailing frequency and recency limits, and specify how to
handle global opt-in and suppression options. See Overview of Audiences.

1. From an open mailing, click the Audience tab.

1493



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

2. To include a list in the audience, click Add Contact List in the Included section. The Select Contact List
window opens.

a. To add a contact list, click New Contact List and see Add a Contact List.
b. Select the list you want to include in the mailing audience and click OK.

The list is added to the Included grid. Contacts belonging to the list will receive the mailing unless they
are in an excluded segment or list.

3. To include a segment in the audience, click Add Segment in the Included section. The Select Segment window
opens.

a. To add a segment, click New Segment and see Create a Segment.
b. Select the segment you want to include in the mailing audience and click OK.

The segment is added to the Included grid. Contacts belonging to the segment will receive the mailing
unless they are in an excluded segment or list.

4. To exclude a list from the audience, click Add Contact List in the Excluded section. The Select Contact List
window opens.

a. Select the list you want to exclude from the mailing audience and click OK.
The list is added to the Excluded grid. Contacts belonging to the list will not receive the mailing.

5. To exclude a segment from the audience, click Add Segment in the Excluded section. The Select Segment
window opens.

a. Select the segment you want to exclude from the mailing audience and click OK.
The segment is added to the Excluded grid. Contacts belonging to the segment will not receive the
mailing.

6. To edit a list or segment that is included in or excluded from the mailing, click Open next to the list or segment
name. See How Contact Lists Work.

7. To remove a list or segment from the Included or Excluded sections, click Remove next to the list or segment
name.

8. Enter eld information to set communication options.

Field Description

Honor global opt-in
 

Select this check box to send the mailing to contacts who did not explicitly opt out
of receiving mailings. Clear this check box to send the mailing to all contacts in the
audience, regardless of their opt-in preference.
 

Limit frequency of communication
 

Select this check box to set a mailing frequency limit, and then enter a maximum
number of mailings and a number of days in which contacts can receive messages
before they are excluded from mailings. When the mailing is launched, it is not sent
to any contacts who have received the maximum number of mailings within the
designated time period. For more information about how this seing works, see
Frequency and Recency Limits.
 
The minimum you can enter is 2 in the last 1 day. The maximum number of days you can
enter is 90.
 

Tip:  To ensure contacts receive only 1 email every “x” number of days, use the
Limit recency of communication seing described in the next entry.
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Field Description

Limit recency of communication
 

Select this check box to set a mailing recency limit. Enter the minimum number of days
that can elapse before contacts receive another email. When the mailing is launched, it
is not sent to any contacts who have received a mailing in the past specied number of
days. For more information about how this seing works, see Frequency and Recency
Limits.
 
The maximum number of days you can enter is 90. The default value is 1 day.
 

Tip:  Use this check box to ensure contacts receive only one email every “x”
number of days. For instance, if you want your contacts to receive only one
email per week, you can select this check box and then set the eld to seven.

Honor external suppression list
 

Select this check box to exclude contacts in the external suppression list from
receiving the mailing. Clear this check box to send the mailing to all contacts in the
audience, even if they are in the external suppression list. See Overview of the External
Suppression List.
 

Limit delivery to a randomly
selected subset of the audience
 

Select this check box to send the mailing to a subset of the audience. Enter a percentage
or use the up and down arrows to select a percentage of the audience to send the
mailing to.
 

Allow delivery of messages to
multiple contacts sharing the same
email address
 

Select this check box to send messages to multiple contacts sharing the same email
address. If this check box is cleared, the message is sent only to the contact most
recently updated.
 
This option is available only when email address sharing is enabled. See Email Address
Sharing.
 

CAUTION:  Because duplicate messages sent to a single address are a
common characteristic of spam, you should select this check box only when
necessary. When the check box is selected and you aempt to schedule
or send a mailing, survey, or proof, and duplicate email addresses exist in
your audience, a message warns you that your reputation as a bulk email
sender may be adversely aected and impact your ability to send future
communications.

Exclude from audience if previously
sent
 

Select this check box to exclude contacts from the audience who were previously sent
a message from the same mailing. This option applies only to recurring mailings.
Contacts excluded in this manner are also excluded from the audience count. See Add
or Edit a Recurring Schedule for a Broadcast Mailing.
 

9. To count the number of contacts who will receive the mailing, click Refresh in the Current Count section.
After the audience has been counted, the last count also displays in this section.
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10. To view the details of an audience count, click Details in the Current Count section after the count has been
performed.

Frequency and Recency Limits  
There are several seings that let you limit the number of emails your customers receive through mailings and surveys.
Two of the seings limit the frequency and recency of email communication with your customers.

Frequency limits let you control the frequency at which your customers receive email from your organization—in
other words, how often an email will be sent to your customers. Recency limits let you dene the number of days that
pass between the emails that you send. Frequency is set using the Limit Frequency of Communication check box
and recency is set using the Limit Recency of Communication check box, both accessed on the Audience tab of your
mailing or survey. For specic details about dening these seings, see the Options Section table in the procedure about
dening your audience.

• Frequency and recency seings apply to the sending of email. These seings are not impacted by survey
completion, views, or clicks. Following are two examples that demonstrate this point.

◦ A customer received an email 31 days ago that included a transactional survey. However, the customer
just submied the survey yesterday. If recency on the next mailing is set to 30 days, the customer could
receive another email from the system.

◦ An agent presents a website link survey in a new browser window at the end of a chat. Since website link
surveys are not associated with email, recency limits do not apply to this survey.

• Frequency and recency seings apply to emails sent from both Outreach and Feedback and cannot be applied
to only one product area. For example, suppose you have a rule to send a transactional survey after an incident
is solved. Also suppose you add an Outreach broadcast mailing with frequency limited to no more than two
messages in the last seven days. Now, one of your customers has two incidents: one solved on Monday and the
other solved on Tuesday. If the broadcast mailing is scheduled for future delivery on Thursday, the customer
will not receive the Outreach email sent by the mailing because of the two Feedback surveys emailed earlier in
the week.

• The system checks for frequency and recency limits at the time the email is sent. The system performs
frequency and recency checks at the scheduled mailing or survey time. (The system also checks for custom
logic such as any segments or business rules at this time.)

View Audience Count Details in Mailings  
You can view the audience count to see how the count is calculated. You can see the included and excluded lists and
segments, along with the number of invalid emails and opt-outs.

You must count your audience before you can view audience count details.
1. Do one of the following:

◦ From the Summary tab, click Details next to Audience Count.

◦ From the Audience tab, click Details next to Current Count.

The Audience Count Details window opens.  
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Column Description

Name
 

Lists the name of each segment or contact list included in or excluded from the mailing.
 

Type
 

Lists whether the audience subset is a contact list or segment.
 

Gross Size
 

Lists the number of contacts belonging to the list or segment.
 

Overlap
 

Lists the number of contacts belonging to the list or segment who also belong to
another list or segment in the audience.
 

Invalid Email
 

Lists the number of contacts belonging to the list or segment who have an invalid email
address.
 

No Email
 

Lists the number of contacts belonging to the list or segment who do not have an email
address.
 

Duplicate Email
 

Lists the number of email addresses shared by multiple contacts. If the check box is
selected on the Audience tab that allows delivery to multiple contacts sharing the same
email address, this count is included in the net size count of the audience. If the check
box is not selected, it is subtracted from the gross size when calculating the net size of
the audience.
 
This option is available only when email address sharing is enabled. See Email Address
Sharing.
 

Suppression
 

Lists the number of email addresses that are excluded from the mailing because they
are part of the external or global suppression list.

Opt-out
 

Lists the number of contacts belonging to the list or segment who have opted out of
mailings.
 

Frequency
 

Lists the number of contacts belonging to the list or segment who are ltered by the
mailing frequency seings.
 

Recency
 

Lists the number of contacts belonging to the list or segment who are ltered by the
mailing recency seings.
 

Net Size of Audience
 

Lists the number of contacts in each list or segment who are included in or excluded
from the mailing.
 

Total Audience Size Lists the net total number of contacts who will receive the mailing.
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Column Description

   

Note:  Audiences are ltered from invitation emails in the following order:

◦ Excluded segments and contacts

◦ Contacts without an email address

◦ Contacts with an invalid email address

◦ Contacts who have opted out

◦ Shared email addresses and duplicate contacts (overlaps in included lists or segments)

◦ Contacts in the global suppression list

◦ Contacts in the external suppression list

◦ Contacts ltered by recency seings

◦ Contacts ltered by frequency seings

Create a Message in Broadcast Mailings  
From the Message tab, you can activate market testing, specify the mailbox seings for the mailing, the subject of the
email, and any URL parameters you want to aach to links in the message.

In addition, you can create either plain text or HTML messages from scratch, from existing content, or by uploading
HTML from another site.

1. From an open mailing, click the Message tab.
2. To activate market testing, click the information bar (above the From address eld) and select Change Market

Testing Mode. See Activate Market Testing in Broadcast Mailings.
3. To change the mailbox sending the message, or the From and Reply-to addresses, click Edit next to the From

address. See Customize the Mailing Message Header.
4. Enter the subject of the message in the Subject eld.

For the best practice on creating eective subject lines, see Ensuring that contacts read your message.
5. To add a merge eld to the subject, click the Merge Field icon (to the right of the Subject eld) and select the

eld.
Merge elds add personalized elements to the subject, such as the contact’s rst name.

6. To create an HTML message from scratch, click Begin with Blank Content and see How the HTML Editor
Works.

7. To create an HTML message by using an existing document, click Choose Existing Content and see Insert
Existing Content.

8. To create an HTML message by uploading your own HTML page, click Upload HTML Content and see Upload
HTML Content.

9. To create a text version of the message, click the Text tab.
10. To create a text message from scratch, click Begin with Blank Content and see How the HTML Editor Works.
11. To create a text message by copying an existing document, click Choose Existing Content.
12. To create a text message by converting an HTML page to text, click Convert HTML Content and see Convert

HTML Content.
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CAUTION:  The system automatically creates a document containing the content created on the
Message tab and stores it in the Automatically Generated folder in the Documents explorer. When you
update the document in the mailing, those changes will also be made to the automatically generated
copy. In addition, if you make any changes to the copy in the Automatically Generated folder, those
changes will also be made to the text on the Message tab in the mailing. See Automatically Generated
Folders.

13. To add URL parameters, enter any parameters you want to append to the links in your message (for example,
p1=v1&p2=v2) in the URL Parameters eld.

14. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld
and select the eld. See Insert a Merge Field to a URL Parameter.

Customize the Mailing Message Header  
If you want to use a dierent name and email address for your mailing, such as a branded email address, you can do so
by customizing the message header.

By default, Outreach uses the name and email addresses specied in the outgoing email seings of your default
Outreach mailbox. By customizing the message header, when a recipient views your mailing, the name and email
addresses dened in the customized header are used instead of those specied in the default Outreach mailbox.

Note:  Be sure to regularly monitor mail received by the email addresses specied in your custom message
header. If you want replies to your mailing to be converted to incidents in Oracle Service Cloud, your mail
administrator must congure SMTP forwarding from that mail account to an account congured in Oracle
Service Cloud. See How Mailboxes Work.

Also note that when an email message cannot be delivered, it usually results in a “bounce” error notication. Bounce
notications are sent to the Envelope From/Bounce Address dened in the outgoing email seings of your Outreach
mailbox even if the message header is customized using the following procedure. See Email Bounce Handling.

1. On the Message tab of an open mailing, click Edit next to the From eld.
The Customize From and Reply-To Headers window opens.

2. Enter eld information.

Field Description

Mailbox Click this drop-down menu and select a mailbox to change the mailbox from the default.
See How Email Works in Outreach and Feedback.

From Enter the name and email address that you want the message to appear from in the
From text boxes.

Name Enter the name you want the message to appear from.

*Email Address Enter the email address you want the message to appear from.

Reply-To Enter the name and email address that you want the message to reply to in the Reply-To
text boxes.

Name Enter the name you want to appear as the reply-to address.

*Email Address Enter the email address you want to appear as the reply-to address.
If you use incidents, the Reply-To Address must match the Envelope From/Bounce
Address unless your own mail administrator has set up SMTP forwarding for this
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Field Description

address to automatically forward to the Envelope From/Bounce Address in the outgoing
emails seings of your mailbox. See the descriptions for outgoing email seings in Edit
an Oracle-Managed Service Mailbox as well as  Answer ID 1272  on our support site.
 

  Merge Field Click this icon to add merge elds to the from name and address or reply-to name and
address.

Preview This section displays how the from and reply-to addresses appear.

3. Click OK.

Related Topics
• Overview of Email Management

• Best Practices for Using Branded Email Domains

Best Practices for Using Branded Email Domains  
Using email addresses branded with your company domain name can help recipients recognize your organization as
the sender, improving deliverability. However, care must be taken to ensure that bounce notications are processed
correctly. Review these recommended best practices when using branded domains to send mailings.

1. Keep the mailbox conguration provided by Oracle—At the time your site was created, an Oracle representative
probably helped congure your Outreach mailbox seings using a mail account with an Oracle domain, such
as rnmk.com. These seings should be left as is to ensure bounce errors are processed. See Email Bounce
Handling.

2. Customize the message header—When creating the mailing message, add your branded email address by
customizing the message header. Customizing the message header does not aect bounce processing, but
contact replies to your email will be sent to the branded address.

3. Implement email authentication—Implementing a form of authentication for your branded email accounts can
help protect your reputation and secure your mail delivery rates. Oracle Service Cloud supports two forms of
authentication.

◦ Sender Policy Framework—Sender Policy Framework (SPF) is an email authentication option that
designates permied senders of email originating from your domain, excluding those with mismatched
or incorrectly specied SPF records. See  Answer ID 2489  on our support site for information about
implementing SPF on your site.

◦ DomainKeys/DomainKeys Identied Mail—DomainKeys (DK) and DomainKeys Identied Mail (DKIM) are
email authentication options that use cryptographic signatures to designate email as originating from
an authorized email delivery provider, excluding messages sent from those with unsigned or incorrectly
assigned signatures. See  Answer ID 2701  on our support site for information about implementing DK
and DKIM on your site.

Insert Existing Content  
As an alternative to creating a message from scratch, you can base your message on existing content. You can choose
to copy content into your message and customize it, or share the content with other surveys and messages that use the
document.

1. From the Message tab of a mailing or the Invitation Message tab of a survey, click Choose Existing Content.
The Choose Document window opens.

2. Select the document you want to use and click OK. If it is not already in use by another mailing, campaign, or
survey, the content is added to your message. Otherwise, the Content Already in Use window opens.
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a. To share the document with the items indicated in the grid, click Share Content.
When you share a document, you can edit the content of the document, but all other messages that
share it are also modied. Likewise, if another sta member edits the document, your message is also
modied.

b. To create a copy of the document, click Copy Content.
If you edit the copied content, the original document is not aected. Conversely, if the content of the
original document is modied, it does not aect your copy of the message.

CAUTION:  The system automatically creates a document containing the copied content and stores it
in the Automatically Generated folder in the Documents explorer. When you update the document in
the mailing or survey, those changes are also made to the automatically generated copy. In addition, if
you make any changes to the copy in the Automatically Generated folder, those changes are also made
to the content of the mailing or survey. See Automatically Generated Folders.

Upload HTML Content  
You can upload an HTML le into your document, template, snippet, mailing or survey to create your message. The
HTML document must be stored in a le accessible through your workstation. You cannot access the HTML of a web
page.

1. From the HTML tab of a document, the Message tab of a mailing, the Invitation Message tab of a survey, or
from a new template or snippet, click Upload HTML Content.

2. Select the HTML le you want to upload.
3. Click Open.

The HTML is inserted in your message.

Convert HTML Content  
When creating a text message, you can take HTML content from the HTML message or from an HTML le and convert
it to plain text.

You should nalize your HTML content before converting it to text.
1. From the Message tab of an open mailing or the Invitation Message tab of an open survey, click the Text tab

and then click Convert HTML Content.
The HTML to Text window opens.

2. To convert the HTML message to text, select HTML Part.

3. To convert an HTML le to text, select the File On Disk and browse for the le.
4. Click OK.

The converted HTML is added to the text part of your message.

Activate Market Testing in Broadcast Mailings  
When creating a broadcast mailing, you can test dierent content and designs on a subset of your audience by using
market testing.

For broadcast mailings, market testing is available in two modes: even split and random sampling.

• Even split—This mode sends your test messages to equal portions of your audience. For example, if you
created four messages, each message would be sent to twenty-ve percent of your audience. In this way, you
can test dierent content and designs for use in future mailings.

• Random sampling—This mode sends test messages to a percentage of the audience you specify. After the test
messages are sent, you send a nal message to remaining audience members. For example, you could send
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two messages to ve percent of your audience each. After determining the most eective message, you would
send a nal message to any audience members who had not received a test message.

By default, the Message tab is set up without market testing. This means you create and send only one message with
the mailing.

1. On the Message tab of an open mailing, click the information bar (above the From address eld) and select
Change Market Testing Mode.
You can also access this window on the Summary tab by clicking Change next to Market Testing.
The Select Market Testing Mode window opens.

2. To send test messages to equal portions of your audience, select Even Split. See Create Messages in Even Split
Mode.

3. To send test messages to a percentage of your audience, select Random Sampling. See Create Messages in
Random Sampling Mode.

4. To disable market testing, select None.

Note:  If you have created more than one test message, the Select Message To Keep window opens
asking which message you want to use. You must select a message to keep before you can disable
market testing.

5. Click OK.

Create Messages in Even Split Mode  
When creating messages in even split mode, you dene dierent message content and proong options for each
version of your message. Your audience is split evenly between the messages. The messages are sent at the same time
and share delivery options.

1. From the Select Market Testing Mode window, select Even Split and click OK.
The Message tab (mailings) or the Invitation Message tab (surveys) displays in even split mode.

By default, one test message is sent to 100 percent of the audience. From here, you can add more messages,
edit messages, send proofs, or view results. From here, you can also see information about each message.

Column Description

Name
 

This column displays the name of the message.
 

Subject
 

This column displays the email subject line for the message.
 

Audience
 

This column displays the percentage of the audience the message will be sent to.
 

Sent
 

This column displays the number of emails sent with the message.
 

Delivered
 

This column displays the number of emails sent with the message that did not bounce.
 

Opened
 

This column displays the number of unique email recipients who opened the message.
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Column Description

Clicked
 

This column displays the number of unique email recipients who clicked a tracked link.
 

Unsubscribed
 

This column displays the number of email recipients who unsubscribed from mailings.
 
Unsubscribe sets global opt-in in both Outreach and Feedback. See Insert an
Unsubscribe Link.
 

Replied
 

This column displays the number of times the mailing was replied to.
 

2. Click New on the toolbar to add a second test message.
The Edit Message window opens.

3. Enter the name of the message in the Name eld.
4. Enter the subject of the message in the Subject eld on the Content tab. See Create a Message in Broadcast

Mailings and Create an Invitation Message in Broadcast Surveys.
5. Dene any other content or formaing options you may want to test using either the HTML editor or the text

editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-Only Messages.
6. To send a proof message, click the Proong tab on the Edit Message window. See Send a Proof.
7. Click OK to save the message.

The new message is added to the Message tab (mailings) or the Invitation Message tab (surveys).
8. To open a message for editing, select the message and click Open.
9. To delete a message, select the message and click Delete.

10. To copy a message to create another test message, select the message and click Copy.

Note:  A document is automatically created and stored in the Automatically Generated folder in the
Documents explorer for every copy of a test message. Changes made to content in any of the copied
test messages is not shared with the original test message or subsequent copies. See Automatically
Generated Folders.

11. To send a proof of a message, select the message and click Send Proof.
12. To preview the content of a message, select the message and click Preview.
13. To refresh the message statistics, click Refresh.
14. To add URL parameters, enter any parameters you want to append to the links in your message (for example,

p1=v1&p2=v2) in the URL Parameters eld.
15. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld

and select the eld. See Insert a Merge Field to a URL Parameter.

Create Messages in Random Sampling Mode  
You should use random sampling mode when you want to send a sample of test messages to your audience before
determining the best one to use as a nal message.

When creating messages in random sampling mode, you dene dierent message content, designs, delivery, and
proong options for each version of your message. After you evaluate the eectiveness of your test messages, you
create a nal message and send it.

For the best practice on how to handle scheduling, see Scheduling Mailings and Surveys for Market Testing.

1. From the Select Market Testing Mode window, select Random Sampling and click OK.
The Message tab (mailings) or Invitation Message tab (surveys) displays in random sampling mode.
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By default, one test message is sent to ve percent of the audience, and one nal message sent to the
remainder of the audience. You can add more messages, edit the messages, send proofs, or view results. From
here, you can also see information about each message.

Column Description

Name
 

This column displays the name of the message.
 

Subject
 

This column displays the email subject line for the message.
 

Status
 

This column displays the status of the message. See Mailing Delivery Statuses and
Survey Delivery Statuses.
 

Audience
 

This column displays the percentage of the audience the message will be sent to.
 

Sent
 

This column displays the number of emails sent with the message.
 

Delivered
 

This column displays the number of emails sent with the message that did not bounce.
 

Opened
 

This column displays the number of unique email recipients who opened the message.
 

Clicked
 

This column displays the number of unique email recipients who clicked a tracked link.
 

Unsubscribed
 

This column displays the number of email recipients who unsubscribed from mailings.
 
Unsubscribe sets global opt-in in both Outreach and Feedback. See Insert an
Unsubscribe Link.
 

Replied
 

This column displays the number of times the mailing was replied to.
 

2. Click New on the toolbar to add a second message.
The Edit Message window opens.

3. Enter the name of the message in the Name eld.
4. Enter the number or percentage of recipients you want to receive the message in the Test Audience eld and

select Percent or Recipients from the drop-down menu.
The percentage of recipients is based on the number of contacts in the audience at the time the mailing is sent.

5. Enter the subject of the message in the Subject eld on the Content tab. See Create a Message in Broadcast
Mailings.

6. Dene any other content or formaing options you may want to test using either the HTML editor or the Text
editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-Only Messages.

7. To send a proof message, click the Proong tab on the Edit Message window. See Send a Proof.
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8. Click the Delivery tab on the Edit Message window to dene the delivery options for the message. See Access
Broadcast Mailing Delivery Options or Access Broadcast Survey Delivery Options.

Tip:  When sending multiple test cells, we recommend scheduling them to be sent all at one time
rather than a few minutes apart. This minimizes any performance impact on your database by sharing
audience segmentation processes across all of the sending cells, instead of performing them multiple
times.

9. Click OK to save the test message.
The new message is added to the Message (mailings) or the Invitation Message (surveys) tab.

10. To open a message for editing, select the message and click Open.
11. To delete a message, select the message and click Delete.

Note:  You cannot delete the nal message.

12. To copy a message to create a new message, select the message and click Copy.
A document is automatically created and stored in the Automatically Generated folder in the Documents
explorer for every copy of a test message. Changes made to content in any of the copied test messages is not
shared with the original test message or subsequent copies. See Automatically Generated Folders.

13. To send a proof of a message, select the message and click Send Proof.
14. To preview the content of a message, select the message and click Preview.
15. To refresh the message statistics, click Refresh.
16. To add URL parameters, enter any parameters you want to append to the links in your message (for example,

p1=v1&p2=v2) in the URL Parameters eld.
17. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld

and select the eld. See Insert a Merge Field to a URL Parameter.
18. When you are satised with your message, you must copy it as your nal message and then dene delivery

options.
a. Select the message and click Copy To Final.

The message you selected is copied to the Final Message section of the Message tab (mailings) or the
Invitation Message (surveys) tab.

b. Click OK.
c. Select the nal message and click Open.

The Edit Message window opens.
d. Click the Delivery tab on the Edit Message window to dene delivery options.

Send a Proof  
An important step in creating a mailing or a survey is ensuring the content is approved by the necessary contacts and
sta members and as a nal check for any mistakes.

You can send a proof to any combination of sta accounts, sta groups, proof lists, distribution lists, and distribution list
available addresses, and then view the results of the proof from the Proong tab. See Add or Edit a Distribution List.

After a reviewer has approved or rejected the proof, the assigned sta member will receive a Mailing Proof Response
Notication or a Survey Proof Response Notication. Both notications can be customized using message templates
found in the Administrator Notications message type under the Outreach or Feedback category respectively. See How
You Customize Messages.
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Proof surveys and mailings are subject to the following behaviors and limitations.

• If your message contains conditional sections, all conditional sections display in the proof message. However,
reviewers see the conditional sections only if they can be mapped to contact records that allow access to those
conditional sections.

• If a form on the proof contains an email address eld and a reviewer submits a value for the eld in the survey
preview, a contact record is created or updated so that advanced survey functions can be tested. For this
reason, be sure that your reviewers use only test contact addresses to avoid updating production contacts
when testing survey proofs.

• To ensure the proong process does not impact statistics after the mailing or survey has been sent, Outreach
and Feedback does not retain data submied from proof surveys. If you want to submit test responses without
impacting specic statistics, you can copy the mailing or survey and test using the copy instead.

For the best practice about sending proofs, see Send Proofs to Key Sta.

1. From an open mailing or survey, click the Proong tab.
2. Click Send Proof Message to select proof recipients.

The Send Proof Message window opens.

Tip:  From the Summary tab, clicking Send Proof Message opens the Send Proof Wizard where you
can select the survey you want to send for a proof, and then follow the wizard as it steps you through
the process of sending your message.

3. To create a proof list, click New Proof List and see Add a Contact List.
4. Enter an email address or the name of a group or proof list in the Recipients eld.
5. To select proof recipients from a list, click the Select Recipients icon (to the right of the Recipients eld). The

Select Names window opens.
a. Select a sta member, address, group, or proof list and click To.
b. To nd a specic sta member, address, group, or proof list, enter the name in the Type Name or Select

From List eld.
The rst item matching the leers you type is selected in the grid.

c. To import your contacts from the default Contacts folder in Outlook, select Load Outlook Contacts. This
is useful for displaying contacts that are not included in Oracle Service Cloud. See How You Synchronize
Contacts.

d. Click OK.
6. Enter any comments you want to appear in the message in the Comment text box.
7. To spell check your comments, click the Spell Check icon (to the right of the Comment eld).
8. To customize your proof message by contact record, which lets your reviewers see how dynamic content will

look for a specic contact, click the Search icon next to the Preview Contact eld on the boom of the window.
The Contact Search window opens.

a. Enter your search criteria in one or more of the available elds and click Search.
A list of contacts that match your search criteria displays in the grid below the search criteria elds.

b. Select a contact and click Select.
The Contact Search window closes and the contact name you selected populates the Preview Contact
eld on the Send Message Proof window.

9. Click Send Proof Message.

Accept or Reject a Proof Email  
After you send a proof, the recipients can accept or reject the mailing or survey content.
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The proof email automatically displays a link to a web page where the tester can accept or reject the content. The word
“Proof:” is prepended to the message subject. The assigned sta member receives either a Mailing Proof Response
Notication or a Survey Proof Response Notication every time a reviewer submits feedback.

1. In a proof email, click the Submit Your Feedback link.
A new window opens where you can make comments and accept or reject the proof.

2. Enter any comments related to the proof mailing or survey in the Comments for Mailing Organizer text box.
3. Do one of the following:

◦ To approve the mailing, click Approve.

◦ To reject the mailing, click Reject.

A message displays conrming your submission.

Proof Results  
After you have sent the proof message, you can easily check the proof results from the Proong tab.

The Proong Results section lists all message proofs that were previously sent for the selected mailing or survey,
grouped by date and time. You can see how many times the proof was viewed, who accepted and rejected the proof,
and any comments from the proof testers.

Column Description

Recipient
 

This column displays all recipients of the proof mailing or survey.
 

Views
 

This column displays the number of times each recipient views the message.
 

Media
 

This column displays whether the recipient received HTML or text content.
 

Approved
 

This column displays whether each recipient approved the proof (Yes or No). The column is blank if the
recipient has yet to approve or reject the proof.
 

Comments
 

This column displays the recipient’s comments.
 

Access Broadcast Mailing Delivery Options  
After you have dened the audience, created a message, and sent a proof mailing, you can send the mailing to your
customers.

The Delivery tab lets you choose to send the mailing immediately or schedule its delivery for sometime in the future. In
addition, you can control the speed of the delivery and access common administration tasks for the mailing.

1. From an open mailing, click the Delivery tab.

The Delivery tab is divided into sections. The Delivery Status section displays the status of the mailing (see
Mailing Delivery Statuses) and contains options for controlling the sending of the mailing. You can perform the
following tasks from this section.

◦ Send a mailing—See Send a Broadcast Mailing.

◦ Schedule a mailing, Reschedule a mailing, and Cancel a mailing schedule—See Schedule a Broadcast
Mailing.

◦ Mailing recurrence—See Add or Edit a Recurring Schedule for a Broadcast Mailing.
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◦ Suspend a mailing—See Suspend a Broadcast Mailing.

◦ Cancel a mailing—See Cancel a Broadcast Mailing.

The Delivery Options section lets you set options related to sending the mailing. See Send a Broadcast Mailing.

On the boom of the tab, delivery information about the mailing is available for you to quickly scan and assess
in the Delivery Checklist and Message Send History sections.

Section Description

Delivery Checklist This section displays the audience count and proof history and provides a link to
preview the survey.

Audience Count This eld displays the most recent audience count and the time and date it was
performed. Click Refresh to perform an updated count. See Dene the Broadcast
Mailing Audience.

Message Preview This section contains a link to preview the message that is sent with the mailing. Click
Preview to preview the message.

Proong This section displays a summary report of message proofs associated with the mailing.
Click Send Proof Message to send the message as a proof. See Proof Results.

CAN-SPAM Compliance This section displays the results of the CAN-SPAM compliance test. Click Test CAN-
SPAM to test the mailing for compliance with the CAN-SPAM Act. Click Details to view
the results of a test. See Check Compliance from the Delivery Tab.

Message Send History This section displays a log of events relating to the delivery status of the mailing. If the
mailing has not been sent, it is noted here.

Send a Broadcast Mailing  
Broadcast mailings can be sent immediately from the Delivery tab. The status changes to Preparing to Send and then
the mailing is sent to your dened audience. After the mailing nishes sending, the status is Completed.

1. On the Delivery tab of an open mailing, enter eld information in the Delivery Options section.

Field Description

Limit delivery rate to no more than x
messages per hour
 

Select this check box to control the rate of delivery, and then click the drop-down menu
to select the number of emails to send per hour when the Limit Delivery Rate check box
is selected.
 

CC proof audience on send
 

Select this check box to copy the sent mailing to your proof message recipients. The
phrase “Proof Copy:” is prepended to the message subject.
 

Note:  Proof members may receive two messages if they are also part of the
audience.
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2. Click Send Now.
3. Click Yes to conrm that you want to send the mailing.

The delivery status changes to Preparing to Send and you can see the delivery progress of the message along
with the audience count.

When the mailing nishes sending, the status changes to Completed and the Delivery Status section displays the
number of emails sent and delivered.

Schedule a Broadcast Mailing  
You can schedule broadcast mailings to be sent on a specied date and time. This lets you coordinate sending a mailing
before the actual send date (for example, to coincide with a product launch). When scheduled, the mailing sends
automatically.

1. On the Delivery tab of an open mailing, enter eld information in the Delivery Options section.

Field Description

Limit delivery rate to no more than x
messages per hour
 

Select this check box to control the rate of delivery, and then click the drop-down menu
to select the number of emails to send per hour when the Limit Delivery Rate check box
is selected.
 

CC proof audience on send
 

Select this check box to copy the sent mailing to your proof message recipients. The
phrase “Proof Copy:” is prepended to the message subject.
 

Note:  Proof members may receive two messages if they are also part of the
audience.

2. Click Schedule.
The Conrm Schedule Mailing window opens.

3. Enter the date and time you want to send the mailing in the Time to Send Mailing eld or click the calendar to
open a calendar and select the date.

4. Click OK.
The Delivery Status section displays the time and date the mailing is scheduled to be sent.

5. To reschedule the mailing, click Reschedule.
6. To cancel a scheduled mailing, click Unschedule.

Note:  Although you do not have to wait until all the test messages are sent before scheduling a nal
mailing, all of the test messages must be sent before the nal mailing can be sent.

Add or Edit a Recurring Schedule for a Broadcast Mailing  
Mailing recurrence lets you send broadcast mailings at regular daily, weekly, monthly, or yearly intervals with a number
of exible options.

• You can schedule mailings to run during a specic date range, or set no end date to allow recurrences to run
indenitely.

• You can schedule mailings to run on specic days of the month or specic months of the year.

• You can send a message to each contact in your audience only once or every time the recurrence is initiated.
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• You can select the time of day that you want messages to begin sending.

Before seing a recurring schedule, you must rst dene the audience and the message subject and content. When
recurrence has been set, you can click Suspend to suspend recurrences. This saves the recurrence information so it can
be edited or reactivated.

Information about past recurrences—such as the time last run, next scheduled runtime, the time the schedule was
last updated, and basic results data—is stored in the knowledge base and tracked in the Recurring Mailings Summary
report. Also, each recurrence is tracked in the mailing audit log along with a description of how many emails were sent.

1. From an open mailing, click the Delivery tab.
2. Click Recurrence.

The Conrm Schedule Recurrence window opens.
3. Enter eld information.

Field Description

Recurrence Paern Select the weekly or monthly interval when the mailing should be sent. For example, a
mailing could be sent every two weeks on Tuesday, or every month on the 7th and 19th.

Clear All Click this text to clear all selected recurrence paern check boxes.

Monthly Select this option to display check boxes for the days of the month. You can then select
the days of the month when the mailing should be sent.

Weekly Select this option to display check boxes for each day of the week. You can then select
the check boxes next to the days when you want the mailing to be sent.
When you select this option, a Recur drop-down menu displays where you can specify
the frequency of the weekly mailing. For example, if you want to send a mailing every
week on the days selected, enter 1 in the eld. If you want the mailing to be sent every
third week on the days selected, enter 3 in the eld. This eld accepts values from 1 to
99.
 

Schedule Specic Months Click this header to display check boxes for the months of the year. Select the months
during which the mailing should be sent. By default, every month is selected, but if
you do not want to send during a specic month, you can clear the check box for that
month.

Clear All Click this text to clear all check boxes for the selected months.

Range of Recurrence Options in this section let you specify a date range for the recurrence and time of day at
which the mailing is sent.

Start

End

Enter the start and end date of the schedule or click the calendar from which you can
select the start and end date. The current day is the default start date.

Time to send mailing Enter the time of day to begin sending the mailing.

4. Click OK to save the recurrence seings and return to the Delivery tab.
5. To suspend the recurrence, click Suspend.

a. Click OK to conrm you want to suspend the recurrence.
After recurrence is suspended, you can click Recurrence again to edit or reactivate it.
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6. To exclude contacts from the audience that were included in a previous instance of the recurrence, click the
Audience tab and select the Exclude From Audience if Previously Sent check box.

Note:  By default, a recurring mailing is sent on every recurrence to every contact who matches
your audience, even contacts who previously received an instance of the same message. If you want
each contact to receive only one instance of a recurring mailing, you need to exclude contacts from
the audience that were previously sent to. This is often helpful when sending a one-time oer. For
instance, sending a one-time oer to all contacts who have a birthday in the next month.

Related Topics
• Audit Logs

Suspend a Broadcast Mailing  
You may want to stop sending a mailing while it is sending or preparing to send. You can temporarily stop a mailing
from sending by suspending it.

1. From the Delivery tab of an open mailing, click Suspend.
This buon appears only when a mailing is in the process of being sent.

2. Click Yes to conrm suspending the mailing.

The status changes to Suspended and the Delivery Status section displays the number of audience members the
mailing was already sent and delivered to.

Cancel a Broadcast Mailing  
You can cancel a mailing at any time. When you cancel a mailing, the mailing is saved and you can still view mailing
results. However, the mailing can no longer be sent or modied.

A canceled mailing can no longer be modied or sent. However, it can be copied to a new mailing, and the copy can be
modied and sent. Instead of canceling your mailing, you may want to consider temporarily suspending it. See Suspend
a Broadcast Mailing.

1. From the Delivery tab of an open mailing, click Cancel Mailing.
2. Click Yes to conrm that you want to cancel the mailing.

The delivery status changes to Canceled.

View Mailing Results  
One of the most important benets of sending mailings is the ability to analyze the results. With Outreach, you have
direct access to a comprehensive dashboard from the Results tab.

You can get up-to-the-minute statistics of mailing results, including the number of clicks, unsubscribes, forwards, and
bounces as well as the number of emails sent and delivered.

Note:  The email gateway must be activated in order for the Techmail utility to capture bounce data for
analytics. See Email Bounce Handling.

1. From an open mailing, click the Results tab.
The list of standard reports displays.

2. Select a report from the list.

Tip:  When you select a report, the report description displays in the area below the list to help you
understand the purpose of the report.

3. Click Go.
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The report opens on a new tab.
4. To view a denition of the report, including its tables, lters, and column descriptions, click Denition on the

ribbon and select View. See View a Report Denition.
5. To view the same report for a dierent mailing, select the mailing from the Mailing drop-down menu at the top

of the open report and then click Search.

Customize the Mailing Report List  
The mailing report list provides a set of useful standard reports that display results information about the mailing you
are editing. However, you can add or remove reports to customize the list.

1. From the Results tab of an open mailing, click Customize List.
The Customize Mailing Report List window opens.

2. To add a report to the mailing report list, select a report from the Available Items list and click Add.
You can also double-click reports to add them.

3. To search for a report in the Available Items list, click Find In List and enter the name (or part of the name) of
the report you are looking for.

4. To remove a report from the mailing report list, select the report in the Selected Items list and click Remove.
5. To rearrange the order of the reports you are adding, select a report in the Selected Items list and click the up or

down arrow.

Tip:  You can also drag and drop reports to adjust their position.

6. Click OK to close the window and update the list.

Added reports display at the boom of the list.

Create a Transactional Mailing  
Transactional mailings let you send a mailing when an event occurs.

You can send the email as part of a campaign. Transactional mailings can also be sent from a contact, opportunity, or
incident rule when a creation or update occurs. For example, when an incident is closed, you can send a mailing to the
incident contact to notify them of product updates.

1. From the Mailings explorer, click New.
A new broadcast mailing opens on the content pane.

Tip:  You can also create a mailing from an open mailing by clicking New. Additionally, if your
navigation set is congured to add mailings from the le menu, click  File > Mailing .

2. Click Change in the Mailing Method section of the Summary tab.
The Select Mailing Method window opens.

3. Select Transactional.
4. Click OK.

By default, the Summary tab is active. From here, you can review general information about the mailing in the
At a Glance section, as well as manage mailing notes, tasks, and aachments. As you create the mailing, you
move through each tab to complete the mailing elements.

Note:  You can also add custom tabs to your mailings. Custom tabs give you quick access to elements
you frequently use in your mailings. See Add a Custom Tab to Mailings.
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5. To assign the mailing to another sta member (by default, the mailing is assigned to the sta member who
creates it), click the Assigned drop-down menu and select the sta member.

a. To search for a sta member, enter the sta member’s name in the Find eld.

Tip:  Wildcards are supported when searching sta members. You can search strings that include
a space by entering %+Space+character, which is helpful when searching last names. For example,
entering %+Space+b returns all last names starting with the leer b. There is also an implied wildcard
when searching, so entering b in the Find eld returns all items containing the leer b.

6. Click the links in the At a Glance section to perform common mailing functions.

Field Description

Mailing Method
 

This eld displays the mailing method currently selected for the mailing. Click Change to
change the method.
 

Market Testing
 

This eld displays the market testing mode of the mailing. Click Change to change
market testing modes.
 

Message
 

Click Preview to preview the mailing.
 

Proong
 

This eld displays the number of proofs that have been sent, approved, and rejected.
Click Send Proof Message to send a proof.
 

Delivery Status
 

This eld displays the delivery status of the mailing and the number of emails sent and
delivered.
 

7. Click the Audience tab to dene an audience for the mailing. See Dene the Transactional Mailing Audience.
8. Click the Message tab to create the email sent to the mailing audience. See How Messages Work in

Transactional Mailings.
9. Click the Proong tab to send a proof of the mailing for internal review before sending it to the entire audience.

See Send a Proof.
10. Click the Delivery tab to select delivery options. See Access Transactional Delivery Options for Mailings.
11. Click the Results tab to view the report associated with the mailing. See View Mailing Results.

If your application is congured with custom tabs for mailings, they display after the Results tab.
12. To spell check the mailing, click Spell Check on the ribbon.
13. Click Save.

The Save As window opens where you can select the folder you want to save the mailing in and enter the name
of the mailing in the Name eld.

14. Click Save.

Related Topics
• Business Rule Actions

• Mailing Management

• Edit Transactional Mailing Aributes

• Congure the File Menu
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Dene the Transactional Mailing Audience  
Even though your rules and campaigns determine which customers receive transaction mailings, you still need to dene
certain audience elements if you want to exclude certain customers or congure opt-out and external suppression list
seings.

You can also restrict the scope of your audience, set mailing frequency and recency limits, and specify how to handle
global opt-in and suppression options. See Overview of Audiences.

1. From an open mailing, click the Audience tab.

Note:  The audience for a transactional mailing automatically includes all contacts who trigger the
associated transactional event. For that reason, you can select only who is excluded from the mailing,
not who is included in it. You can exclude a total of fty contact lists and segments, each containing a
vast number of contacts.

2. To exclude a list from the audience, click Add Contact List in the Excluded section. The Select Contact List
window opens.

a. To add a contact list, click New Contact List and see Add a Contact List.
b. Select the list you want to exclude from the mailing audience and click OK.

The list is added to the Excluded grid. Contacts belonging to the list do not receive the mailing.
3. To exclude a segment from the audience, click Add Segment in the Excluded section. The Select Segment

window opens.
a. To add a new excluded segment, click New Segment and see Create a Segment.
b. Select the segment you want to exclude from the mailing audience and click OK.

The segment is added to the Excluded grid. Contacts belonging to the segment will not receive the
mailing.

4. To edit a list or segment that is excluded from the mailing, click Open next to the list or segment name.
5. To remove a list or segment from the Excluded section, click Remove next to the list or segment name.
6. Enter eld information to set communication options.

Field Description

Honor global opt-in
 

Select this check box to send the mailing to contacts who did not explicitly opt out
of receiving mailings. Clear this check box to send the mailing to all contacts in the
audience, regardless of their opt-in preference.
 

Limit frequency of communication
 

Select this check box to set a mailing frequency limit, and then enter a maximum
number of mailings and a number of days in which contacts can receive messages
before they are excluded from mailings. When the mailing launches, it is not sent to any
contacts who have received the maximum number of mailings within the designated
time period. For more information about how this seing works, see Frequency and
Recency Limits.
 
The minimum you can enter is 2 in the last 1 day. The maximum number of days you can
enter is 90.
 

Tip:  To ensure contacts receive only 1 email every “x” number of days, use the
Limit recency of communication seing described in the next entry.
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Field Description

Limit recency of communication
 

Select this check box to set a mailing recency limit. Enter the minimum number of days
that should elapse before contacts receive another email. When the mailing launches,
 it is not sent to any contacts who have received a mailing in the past specied number
of days. For more information about how this seing works, see Frequency and Recency
Limits.
 
The maximum number of days you can enter is 90. The default value is 1 day.
 

Tip:  Use this check box to ensure contacts receive only one email every “x”
number of days. For instance, if you want your contacts to receive only one
email per week, you can select this check box and then set the eld to seven.

Honor external suppression list
 

Select this check box to exclude contacts in the external suppression list from
receiving the mailing. Clear this check box to send the mailing to all contacts in the
audience, even if they are in the external suppression list. See Overview of the External
Suppression List.
 

Limit delivery to a randomly
selected subset of the audience
 

Select this check box to send the mailing to a random subset of the audience. Enter a
percentage or use the up and down arrows to select a percentage of the audience to
send the mailing to.
 

Allow delivery of messages to
multiple contacts sharing the same
email address
 

Select this check box to send messages to multiple contacts sharing the same email
address. If this check box is cleared, the message is only sent to the contact most
recently updated.
 
This option is available only when email address sharing is enabled. See Email Address
Sharing.
 

CAUTION:  Because duplicate messages sent to a single address are a
common characteristic of spam, you should select this check box only when
necessary. When the check box is selected and you aempt to schedule
or send a mailing, survey, or proof, and duplicate email addresses exist in
your audience, a message warns you that your reputation as a bulk email
sender may be adversely aected and impact your ability to send future
communications.

How Messages Work in Transactional Mailings  
From the Message tab, you can activate market testing and specify the mailbox seings for the mailing, the subject of
the email, and any URL parameters you want to aach to links in the message.

In addition, you can create either plain text or HTML messages from scratch, from existing content, or by uploading
HTML from another site. Creating a message in transactional mailings follows the same procedure as creating a
message in broadcast mailings. See Create a Message in Broadcast Mailings.
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Activate Market Testing in Transactional Mailings  
When creating a transactional mailing, you can send a sample of test messages to portions of your audience before
determining the best one to use as a nal message. You can dene dierent message content, designs, delivery, and
proong options for each version of your message.

For transactional mailings, market testing is available in audience sampling mode. If more than one message is created
when market testing is used, then contacts who are sent the email through a campaign or rule will receive one of the
test messages. When the mailing is launched  through a campaign, market testing rotates between the test messages.
After you evaluate the eectiveness of your test messages, you create a nal message.

1. On the Message tab of an open mailing, click the information bar and select Change Market Testing Mode.
The Select Market Testing Mode window opens.

2. Select Audience Sampling.
3. Click OK.

The Messages tab displays in audience sampling mode.
From here, you can add more messages, edit the messages, send proofs, or view results. You can also see
information about each message.

Column Description

Name
 

This column displays the name of the message.
 

Subject
 

This column displays the email subject line for the message.
 

Status
 

This column displays the delivery status of the message.
 

Sent
 

This column displays the number of emails sent with the message.
 

Delivered
 

This column displays the number of emails sent with the message that did not bounce.
 

Opened
 

This column displays the number of unique email recipients who opened the message.
 

Clicked
 

This column displays the number of unique email recipients who clicked a tracked link.
 

Unsubscribed
 

This column displays the number of email recipients who unsubscribed from mailings.
 

Note:  Unsubscribe sets global opt-in in both Outreach and Feedback. See
Insert an Unsubscribe Link.

Replied
 

This column displays the number of times the mailing was replied to.
 

4. Click New on the toolbar to add a second test message.
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The Edit Message window opens.
5. Enter the name of the message in the Name eld.
6. Enter the subject of the message in the Subject eld on the Content tab. See How Messages Work in

Transactional Mailings.
7. Dene any other content or formaing options you may want to test using either the HTML editor or the Text

editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-Only Messages.
8. To send a proof message, click the Proong tab on the Edit Message window. See Send a Proof.
9. Click the Delivery tab on the Edit Message window to access delivery options. See Access Transactional

Delivery Options for Mailings.
10. Click OK.

The new test message displays on the Messages tab.
11. To open a message for editing, select the message and click Open.
12. To delete a message, select the message and click Delete.
13. To copy a message to create another test message, select the message and click Copy.

A document is automatically created and stored in the Automatically Generated folder in the Documents
explorer for every copy of a test message. Changes made to content in any of the copied test messages are not
shared with the original test message or subsequent copies. See Automatically Generated Folders.

14. To send a proof of a message, select the message and click Send Proof.
15. To preview the content of a message, select the message and click Preview.
16. To refresh the message statistics, click Refresh.
17. To add URL parameters, enter any parameters you want to append to the links in your message (for example,

p1=v1&p2=v2) in the  URL Parameters eld.
18. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld

and select the eld. See Insert a Merge Field to a URL Parameter.

Access Transactional Delivery Options for Mailings  
After you have dened the audience, created a message, and proofed the mailing, you can launch the mailing so it
becomes active in rules and campaigns. From the Delivery tab, you can launch, suspend, or cancel the mailing, as well
as access common administration tasks and see the send history.

1. From an open mailing, click the Delivery tab.

The Delivery tab is divided into sections. The Delivery Status section displays the status of the mailing (see
Mailing Delivery Statuses) and contains buons for controlling the sending of the mailing. You can perform the
following tasks from this section.

◦ Launch a mailing—See Launch a Transactional Mailing.

◦ Suspend a mailing—See Suspend a Transactional Mailing.

◦ Cancel a mailing—See Cancel a Transactional Mailing.

On the boom of the tab, delivery information about the mailing is available for you to quickly scan and assess
in the Delivery Checklist and Message Send History sections.

Section Description

Message Preview
 

Contains a link to preview the message that is sent with the mailing. Click Preview to
preview the message.
 

Proong
 

Displays a summary report of message proofs associated with the mailing. Click Send
Proof Message to send the message as a proof. See Send a Proof.
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Section Description

 

CAN-SPAM Compliance
 

Displays the results of the CAN-SPAM compliance test. Click Test CAN-SPAM to test the
mailing for compliance with the CAN-SPAM Act. Click Details to view the results of a
test. See Check Compliance from the Delivery Tab.
 

Message Send History
 

Displays a log of events relating to the delivery status of the mailing. If the mailing has
not been sent, it is noted here.
 

Launch a Transactional Mailing  
After you launch a mailing, the status changes to Launched. From the Launched status, you can suspend the mailing or
cancel it.

Transactional mailings must be launched before they can be used in rules or campaigns.

Note:  A launched transactional mailing cannot be edited. However, you can suspend the transactional mailing
message, make edits, and then re-launch it. See Suspend a Transactional Mailing.

1. From the Delivery tab of an open mailing, click Launch.
2. Click Yes to conrmation launch of the mailing.

Delivery status changes to Launched and you can see how many mailings were sent and delivered.

Suspend a Transactional Mailing  
You may want to stop sending a mailing after it has already been launched. You can temporarily stop a mailing from
sending by suspending it.

1. From the Delivery tab of an open mailing, click Suspend.
This buon appears only when a mailing is in the process of being sent.

2. Click Yes to conrm suspending the mailing.

The status changes to Suspended and the Delivery Status section displays the number of audience members the
mailing was already sent and delivered to.

Cancel a Transactional Mailing  
You can cancel a mailing at any time. When you cancel a mailing, the mailing is saved and you can still view mailing
results. However, the mailing cannot be launched again or further modied.

A canceled mailing can no longer be modied or sent. However, it can be copied to a new mailing, and the copy can be
modied and sent. Instead of canceling your mailing, you may want to consider temporarily suspending it. See Suspend
a Transactional Mailing.

1. From the Delivery tab of an open mailing, click Cancel Mailing.
2. Click Yes to conrm that you want to cancel the mailing.

The delivery status changes to Canceled.
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Add a Custom Tab to Mailings  
Custom tabs give you quick access to elements you use frequently in your mailings.

For example, if you use images in your mailings, you could add a tab with a URL link to the place where your images are
stored. Likewise, if you use a web-based email deliverability tool (or any other type of web-based program), you could
link to those programs.

You can also use merge elds in your custom tab to include aributes of the mailing in query string parameters or URL
redirect links. See Insert a Text Merge Field and Edit Redirect to URL Aributes. Custom tabs display after the Results tab
on the mailings editor.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click Conguration Seings.

The Search window opens.
3. Clear the Select All check box under Folders, select the RightNow User Interface check box, and click Search.

The Conguration Seings editor opens.
4. Double-click the MAILING_EDITOR_TABS seing in RightNow User Interface/Miscellaneous/General to

open the seing on the content pane.

Tip:  To display conguration seings in alphabetical order, click in the Key column header.

5. To add a URL link to your custom tab, enter the label name and the associated link in the Value eld using the
following syntax: (tab("<label name>",<URL>))

6. To add a merge eld, enter the following sample code in the Value eld: (tab("Revenue",http://oracle.com/
revenue?report.php?mailing=$mailing.mailing_id))

7. To add more than one custom tab, press Enter to begin a separate line, and repeat steps 5 and 6.
8. Click Save.

Your custom tab displays next to the Results tab on every new and existing mailing after you log out and then log back
in.

CAN-SPAM Compliance  
Oracle Service Cloud helps you identify CAN-SPAM compliance issues. When creating a mailing or survey with a
message, the system automatically checks that the message contains a physical address, an unsubscribe link, and
honors global opt-in preferences. Remaining requirements must be manually veried by the mailing or survey designer.

Legal denitions and penalties for spam vary among countries. Therefore, it is important to stay abreast of current and
pending legislation in the United States and other countries. There are many sites that you can check to stay current
with the laws and to make sure your site is compliant.

The CAN-SPAM Act of 2003 (CAN-SPAM) requires that organizations adhere to certain rules when sending commercial
emails. Included in the requirements are the following conditions:

• Email does not contain false or misleading header information.

• Email does not use a deceptive subject line.

• Email contains a way for recipients to opt out of all emails, not just specic types.

• Email does not send to contacts that have previously opted out.
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• Email must be identied as an advertisement in the subject line.

• Email includes the sender’s physical mailing address, which must display in ASCII text.

• Email that contains adult content is identied as such in the subject line.

• Email does not send to harvested or generated email addresses.

• Email does not send to domains in the Federal Communications Commission (FCC) wireless domain list.

Note:  The checklist is used to gauge your compliance with CAN-SPAM. You should use this checklist in
conjunction with and not as a replacement for legal counsel.

You can check for CAN-SPAM compliance from the Message tab of a mailing, the Invitation Message tab of a survey,
and the Delivery tab of a mailing or survey.

For information about the CAN-SPAM Act, see the  Federal Trade Commission (FTC) website .

Related Topics
• Check Compliance from the Invitation Message Tab

• Check Compliance from the Message Tab

• Check Compliance from the Delivery Tab

Check Compliance from the Message Tab  
Testing for CAN-SPAM compliance issues can be accessed from both the Message and the Delivery tabs in a mailing.

The system automatically checks that the message contains a physical address and an unsubscribe link, and honors
global opt-in preferences. The remaining requirements must be manually veried by the sta member creating the
mailing. For best practices related to mailings, see Improving your email marketing.

1. From the Message tab of an open mailing, do one of the following:

◦ Click Test CAN-SPAM in the Content section of Tasks on the HTML editor.

◦ From the Delivery tab, click Test CAN-SPAM in the Delivery Checklist section.

The CAN-SPAM Compliance Report opens.

The report shows whether each system-veried requirement passed or failed. The manually veried
requirements can be selected or cleared based on your manual verications.

Field Description

System Veried
 

This section shows whether the following system-veried requirements passed or
failed.
 

Must Include Physical Address
 

The system automatically veries that a physical address is included in the message. For
this requirement to pass, you must have inserted a physical address by clicking Insert
Address in the tasks on the HTML editor. See Insert a Physical Address. If a text address
has not been inserted using Insert Address, the requirement fails.
 

Must Include a Working Opt-Out
Method

The system automatically veries that a global unsubscribe link is included in the
message. The unsubscribe link can be added by clicking Unsubscribe Link in the toolbox
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  of the HTML editor. When Unsubscribe Link is clicked, a window opens for selecting
the opt-in eld. If Global Opt-In is selected, the requirement passes when CAN-SPAM
compliance is checked.
 

Must Honor Opt-Out Requests
within 10 Days
 

The system automatically veries whether the global opt-in seing is honored by
the mailing or survey. By default, the Honor Global Opt-In check box is selected on
the Audience tab, which prevents messages from sending to contacts who have
globally opted out of receiving communications. If this check box is not selected, the
requirement fails when compliance is checked.
 
Since contacts are instantly unsubscribed when they globally opt out of mailings, any
global opt-out requests are automatically met within 10 days.
 

Manually Veried
 

This section lets you to select whether the following requirements passed or failed.
 

Has Candid Subject Line
 

You must manually verify that the message uses a candid subject line. CAN-SPAM
compliance requires that the subject line of an email accurately reects its contents. To
pass this requirement, you should ensure that the subject line is not deceptive to the
email recipient. You can view the subject line in the Preview section.
 

Indicates any Adult Content in
Subject
 

You must manually verify that the subject identies adult content in the message. The
CAN-SPAM act requires that a message containing adult content must contain the text
“SEXUALLY EXPLICIT” in the subject line of the email. You can view the subject line in
the Preview section.
 

Indicates Any Advertisement in
Subject
 

You must manually verify that the subject identies the message as an advertisement,
when applicable. The CAN-SPAM act requires that the message contains clear and
conspicuous notice that the message is an advertisement or solicitation. To pass this
requirement, you should ensure that the subject line accurately reects the message
content. You can view the subject line in the Preview section.
 

Has Accurate From and Reply-To
Headers
 

You must manually verify that the From and Reply-To headers contain accurate
information. CAN-SPAM compliance requires that the From and Reply-To headers and
routing information, including the originating name and email address, must accurately
identify your organization. You can view the From and Reply-To headers and the return
path in the Preview section.
 

Does Not Send to Harvested or
Generated Addresses
 

You must manually verify that you are not sending the message to harvested or
generated addresses. Harvested email addresses are gathered from websites or web
services that have published a notice prohibiting the transfer of email addresses for the
purpose of sending email. Generated email addresses are formed by using a “dictionary
aack,” by combining names, leers, or numbers into multiple permutations.
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Does Not Send to Domains in FCC
Wireless List
 

You must manually verify that you are not sending the message to email addresses
that contain domains in the FCC wireless list. The CAN-SPAM act prevents the sending
of messages to wireless devices, such as mobile phones. The FCC publishes a list of
domain names used by cellular companies that you can download at  downloadable list
of domain names used by cellular companies .
 

Overall Compliance
 

This section indicates whether the email is entirely CAN-SPAM compliant. All of the
compliance criteria in this table must be met for overall compliance to pass.
 

Preview
 

This section lets you preview the following parts of a mailing.
 

Preview Message
 

Click this text to preview the message.
 

Subject
 

Displays the subject of the mailing message.
 

Return-Path
 

Displays the mailbox address the message is being sent from.
 

From
 

Displays the From address of the message.
 

Reply-To
 

Displays the Reply-To address of the message.
 

2. Select the check box next to the manually veried items that you have veried.
3. Click OK.

Check Compliance from the Delivery Tab  
You can check for CAN-SPAM compliance issues from the Delivery tab of a mailing or survey. You can also test CAN-
SPAM compliance from the Message tab of a mailing or the Invitation Message tab of a survey.

The system automatically checks that the message contains a physical address and an unsubscribe link, and honors
global opt-in preferences. The remaining requirements must be manually veried by the sta member creating the
mailing or survey.

1. Open a mailing or survey and click the Delivery tab.
2. Click Test CAN-SPAM in the Delivery Checklist section.

The CAN-SPAM Compliance Report opens.

The report shows whether each system-veried requirement passed or failed. The manually veried
requirements can be selected or cleared based on your manual verications.
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System Veried
 

This section shows whether the following system-veried requirements passed or
failed.
 

Must Include Physical Address
 

The system automatically veries that a physical address is included in the message.
For this requirement to pass, you must have inserted a physical address clicking Insert
Address on the HTML editor. See Insert a Physical Address. If a text address has not
been inserted using Insert Address, the requirement fails.
 

Must Include a Working Opt-Out
Method
 

The system automatically veries that a global unsubscribe link is included in the
message. The unsubscribe link can be added by clicking Unsubscribe Link in the toolbox
of the HTML editor. When Unsubscribe Link is clicked, a window opens for selecting
the opt-in eld. If Global Opt-In is selected, the requirement passes when CAN-SPAM
compliance is checked.
 

Must Honor Opt-Out Requests
within 10 Days
 

The system automatically veries whether the global opt-in seing is honored by the
survey. By default, the Honor Global Opt-In check box is selected on the Audience tab,
which prevents messages from sending to contacts who have globally opted out of
receiving communications. If this check box is not selected, the requirement fails when
compliance is checked. Since contacts are instantly unsubscribed when they globally opt
out of surveys, any global opt-out requests are automatically met within 10 days.
 

Manually Veried
 

This section lets you select whether the following requirements passed or failed.
 

Has Candid Subject Line
 

You must manually verify that the message uses a candid subject line. CAN-SPAM
compliance requires that the subject line of an email accurately reects its contents. To
pass this requirement, you should ensure that the subject line is not deceptive to the
email recipient. You can view the subject line in the Preview section.
 

Indicates any Adult Content in
Subject
 

You must manually verify that the subject identies adult content in the message. The
CAN-SPAM Act requires that a message containing adult content must contain the text
“SEXUALLY EXPLICIT” in the subject line of the email. You can view the subject line in
the Preview section.
 

Indicates Any Advertisement in
Subject
 

You must manually verify that the subject identies the message as an advertisement,
when applicable. The CAN-SPAM Act requires that the message contains clear and
conspicuous notice that the message is an advertisement or solicitation. To pass this
requirement, you should ensure that the subject line accurately reects the message
content. You can view the subject line in the Preview section.
 

Has Accurate From and Reply-To
Headers
 

You must manually verify that the From and Reply-To headers contain accurate
information. CAN-SPAM compliance requires that the From and Reply-To headers and
routing information, including the originating name and email address, must accurately
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identify your organization. You can view the From and Reply-To headers and the return
path in the Preview section.
 

Does Not Send to Harvested or
Generated Addresses
 

You must manually verify that you are not sending the message to harvested or
generated addresses. Harvested email addresses are gathered from websites or web
services that have published a notice prohibiting the transfer of email addresses for the
purpose of sending email. Generated email addresses are formed by using a “dictionary
aack,” by combining names, leers, or numbers into multiple permutations.
 

Does Not Send to Domains in FCC
Wireless List
 

You must manually verify that you are not sending the message to email addresses
that contain domains in the FCC wireless list. The CAN-SPAM Act prevents the
sending of messages to wireless devices, such as mobile phones. The FCC publishes a 
downloadable list of domain names used by cellular companies .
 

Overall Compliance
 

This section indicates whether the email is entirely CAN-SPAM compliant. If any of the
compliance criteria in this table fails, overall compliance fails.
 

Preview
 

This section lets you preview the following parts of a message.
 

Preview Message
 

Click this text to preview the message.
 

Subject
 

Displays the subject of the message.
 

Return-Path
 

Displays the mailbox address the message is being sent from.
 

From
 

Displays the From address of the message.
 

Reply-To
 

Displays the Reply-To address of the message.
 

3. To view a read-only copy of the results from the last time CAN-SPAM compliance was tested, click Details next
to CAN-SPAM Compliance on the Delivery tab.
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Outreach Campaigns  

Overview of Campaigns  
Oracle RightNow Outreach Cloud Service (Outreach) provides a powerful solution for building and managing dynamic,
multiple-step marketing campaigns. Using the intuitive campaign designer, you can create your campaign as a ow
diagram comprised of a series of conditional elements that can trigger a variety of business processes.

Based on criteria you dene, your campaign can send mailings, add contacts to lists, create incidents and opportunities,
notify sta, and perform many other useful actions. In addition, you can dene a budget and predict your return on
investment. After your campaign is launched, you can review its results and compare them against your estimates to
evaluate the eectiveness of your design.

When creating and editing a campaign, you perform most tasks using the ribbon, canvas, and campaign components.
These tools provide all of the resources you need to design and launch any campaign, simple or complex.

Campaign Design Ribbon Home Tab  
The campaign design ribbon includes three standard tabs (Home, Insert, and View) and two contextual tabs (Element
Tools and Path Tools) that become visible when an element or connector is selected. Each tab has one or more groups
containing buons for modifying the campaign or elements on the canvas.

The Home tab gives you access to options that impact the entire campaign. For example, you can manage campaign
details, review results, create tasks, select element types, and validate, launch, and suspend the campaign.

Group/Buon Description

Clipboard The buons in this group provide access to basic editing commands when working with components
on the canvas.

Paste Click this buon to paste the contents of the clipboard.

Cut Click this buon to cut selected components from the canvas to the clipboard.

Copy Click this buon to copy selected components from the canvas to the clipboard.

Delete Click this buon to delete selected components from the canvas.

Display The buons in this group display dierent campaign details on the content pane.

Design Click this buon to display the design canvas on the content pane. When a campaign is rst created,
 this buon is active by default.

Details Click this buon to display the campaign details on the content pane. See Set Campaign Details.

Notes Click this buon to add notes about the campaign.

Results Click this buon to review the campaign results.

Audit Log Click this buon to view the audit log.

Aachments Click this buon to add aachments to the campaign.
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Group/Buon Description

Tasks Click this buon to add tasks to the campaign. See Set Campaign Details.

Refresh Click this buon to see the latest updated information as you are editing your campaign. For example,
 on a Scheduled Entry Point, clicking this buon would update the last run, next run, and last modied
information.

Elements The buons in this group let you add campaign components to your ow diagram. For a description of
available components, see Create a Campaign Flow Diagram.

Note:  Components can also be accessed from the Campaign Components toolbox.

Launch The buons in this group let you launch or suspend the campaign.

Launch Click this buon to launch the campaign.

Suspend Click this buon to suspend the campaign. When a campaign is rst created, this buon is active by
default.

Validate Click this buon to check the campaign ow diagram for errors. See Campaign Validation.

Spelling Click this buon to check for spelling errors in the editable text portions of the campaign.

Info Click this buon to view information about the campaign.

Campaign Design Ribbon Insert Tab  
The Insert tab lets you add components to your campaign ow diagram, either one at a time or in predened campaign
templates.

Group/Buon Description

Template
 

The buons in this group let you select a predened ow template to apply to your campaign. See
Apply a Campaign Template.
 

CAUTION:  When you add a template, any content you previously added is deleted from the
canvas.

Ad Conversion
 

Hover over this buon to see a preview of the Ad Conversion campaign template. Click the buon to
add the template to the canvas. See Ad Conversion.
 

Email Promotion
 

Hover over this buon to see a preview of the Email Promotion campaign template. Click the buon to
add the template to the canvas. See Email Promotion.
 

Event Registration
 

Hover over this buon to see a preview of the Event Registration campaign template. Click the buon
to add the template to the canvas. See Event Registration.
 

Information Request
 

Hover over this buon to see a preview of the Information Request campaign template. Click the
buon to add the template to the canvas. See Information Request.
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Subscription Management
 

Hover over this buon to see a preview of the Subscription Management campaign template. Click the
buon to add the template to the canvas. See Subscription Management.
 

Elements
 

The buons in this group let you select components to add to your ow diagram. See Create a
Campaign Flow Diagram.
 
Components can also be accessed from the toolbox.
 

Campaign Design Ribbon View Tab  
The View tab provides access to the component toolbox and options for changing your view of the design canvas.

You can change the view of the design canvas from the View tab, including displaying design grid elements and
adjusting the zoom level. These options make it easier to review and edit your ow diagram.

Group/Buon Description

Campaign Components
 

Click this buon to display the toolbox.
 

Canvas
 

The check boxes and drop-down menu in this group let you select canvas options.
 

Labels
 

Select this check box to display labels for elements in the diagram.
 

Connector Labels
 

Select this check box to display labels for connectors in the diagram. Labels display by default.
 

Validation Results
 

Select this check box to display validation icons in the diagram.
 

Grid
 

Select this check box to display the canvas grid.
 

Grid Size
 

Click this drop-down menu to select the size of the canvas grid.
 

Zoom
 

The buons in this group let you select a zoom level for the canvas.
 

Zoom
 

Click this buon to access the Zoom Options window. See Set Zoom Options.
 

100 percent
 

Click this buon to view the canvas at its normal size.
 

Fit To Screen
 

Click this buon to adjust the zoom level to show all elements.
 

Extents
 

Click this buon to show the entire canvas.
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Set Canvas Options  
You can set canvas options that are available from the View tab on the campaign design ribbon.

1. To display labels for elements on the canvas, select the Labels check box.
2. To display labels for connectors on the canvas, select the Connector Labels check box.
3. To display validation results on the canvas, select the Validation Results check box. See Campaign Validation.
4. To display the canvas grid, select the Grid check box.
5. To change the size of the canvas grid, click the Grid Size drop-down menu.

Set Zoom Options  
You can set zoom options that are available from the View tab.

1. Click Zoom on the View tab.
The Zoom Options window opens.

2. To specify a desired zoom level, select an option in the Zoom To section.
a. To adjust the zoom level to show all components, select Fit to Screen.
b. To show the entire canvas, select Extents.

3. Enter a zoom percentage in the Percent eld. Click the up or down arrow to increase or decrease the value.

Tip:  You can also change the magnication of the canvas using the zoom slider located in the boom
right corner of the Service Console.

4. Click OK.

Campaign and Survey Element Tools Tab  
When you select an element on the canvas of a campaign or an advanced survey, the design ribbon displays a
contextual tab called the Element Tools tab.

The contextual tabs that display on the ribbon depend on your selection. When you select an element or a connector,
the ribbon displays a fourth contextual tab. When an element is selected, the Element Tools tab displays. The Element
Tools tab is divided into two sections. On the left are contextual groups and options, meaning they change depending
on the element selected. On the right are standard groups and options, meaning they display no maer what element is
selected.

Group/Buon Description

Label
 

The options in this group let you change the font style, size, and color. You can select font aributes,
 such as bold and italic, and change the text alignment.
 

(Label Position)
 
 

Click this icon to select the position of the label relative to the element. The default label position of a
new element is Inside.
 

 

Click this icon to enter the text of the element label.
 
You can also edit the label text inline by clicking the element label.
 

Notes
 

Click this option to enter notes about the element.
 

Size The options in this group let you change the height and width of the element.

1528



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Group/Buon Description

   

Campaign and Survey Path Tools Tab  
When you select a connector on the canvas of a campaign or an advanced survey, the design ribbon displays a
contextual tab called the Path Tools tab.

The options on this tab let you format the connector and change the connector type. See Connectors in Campaigns and
Connectors in Surveys.

Group/Buon Description

Type
 

Click this drop-down to change the type of the selected connector.
 
A connector type can be changed only when it is not connected to a standard or event-triggering
element.
 

Style
 

The options in this group let you change the line style of the selected connector.
 

Straight
 

Click this option to set the connector line style to straight.
 

Square
 

Click this option to set the connector line style to square.
 

Rounded Square
 

Click this option to set the connector line style to rounded square.
 

Curved
 

Click this option to set the connector line style to curved.
 

Create a Campaign  
Outreach provides an intuitive graphical interface for creating and editing campaigns. When designing a campaign,
you can drag components from the toolbox and order them on the canvas. You can select components from either the
Home or Insert tab on the ribbon.

You can also dene the objectives for the campaign by including a text summary and estimating expenses and return
on investment. After the campaign has been launched, you can view its results to assess the eectiveness of your
eorts.

Note:  The following procedure assumes that you access the Campaigns explorer from the Campaigns
navigation list. However, this explorer may reside in a dierent navigation list.

1. Click Campaigns on the navigation pane and double-click Campaigns Explorer.
The Campaigns explorer opens on the content pane.

2. Click New to select a starting point for your new campaign.
a. Click Blank Campaign to open a new campaign with a blank design canvas.
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b. To create a new campaign by copying the design of an existing campaign, click Choose Existing
Campaign. See Choose an Existing Design.

c. To create a new campaign by copying a campaign template, click Choose a Campaign Template. See
Apply a Campaign Template.

Tip:  You can also create campaigns from an open campaign by clicking New. Additionally, if your
navigation set is congured to add campaigns from the le menu, click  File > Campaign . By default,
the design canvas is active when creating a campaign. From here, you can design the campaign ow
diagram. See Create a Campaign Flow Diagram.

3. To manage campaign details, including assignment, start and end dates, and objectives, click Details from the
Display group on the ribbon. See Set Campaign Details.

4. To view the campaign results, click Results from the Display group on the ribbon. See View Campaign Results.
Note that this report will display no data until the campaign has been launched.

5. To add tasks to the campaign, click Tasks from the Display group on the ribbon. See Add a Task to a Campaign.
6. Click Save.

The Save As window opens where you can select the folder you want to save the campaign in and enter the
name of the campaign in the Name eld.

7. Click Save.

Related Topics
• Congure the File Menu

Create a Campaign Flow Diagram  
The rst step in creating a campaign is to design a ow diagram. The ow diagram is a graphical representation of the
campaign “ow,” the actions and decisions your campaign will perform, and the order in which it will perform them.

Your ow diagram can be as simple as a single path connecting a few actions, or it can be complex, routing your
audience through dozens of actions, paths, and decision points. With its simplied graphical interface, Outreach makes
creating a complex workow as easy as clicking and dragging component elements into a logical order.

Whether your business needs are simple or complex, start by reviewing the elements available in the toolbox and
consider how each might help accomplish the key objectives of your campaigns. When you have a clear idea which
elements will be useful, you can create the ow diagram by dragging them from the toolbox to the canvas, inserting
each element in a logical position, and connecting them to dene the sequence of action. After an element has been
inserted, you can double-click it to open a window where you can edit its aributes.

Tip:  When explaining aributes that can be edited on a window or the ribbon, we describe the procedure
using the window. However, keep in mind that the ribbon provides easy access to most of the same aributes
available on windows, without the need to double-click. Campaign components can also be dragged to your
ow diagram from the Elements groups on the Home and Insert tabs.

When a campaign is launched and a contact performs the rst action, the decisions and actions in each element are
evaluated and executed in the sequence you have specied. For example, when a contact submits a web form, your
campaign evaluates the information provided and executes the next action, such as creating a sales lead and sending a
follow-up message to the contact.

1. From an open campaign, drag and drop a campaign component element from the toolbox onto the canvas.
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Element Description

Event Triggering Elements
 

Event-triggering elements serve as starting points for campaigns.
 

Serve Web Page
 

Drag and drop this element to serve a web page. After adding this element, double-click
it to dene its aributes. Right-click to preview the web page. See Edit Serve Web Page
Aributes.
 

Broadcast Mailing
 

Drag and drop this element to send a broadcast mailing.
 
After a broadcast mailing has been added to a campaign, it cannot be added to any
other campaign.
 
After adding this element, double-click it to dene its aributes. See Edit Broadcast
Mailing Aributes.
 

Entry Point
 

Drag and drop this element to create a standard entry point to the campaign. Entry
points can be used to send a contact through the campaign from an outside source by
using the Data Upload Wizard. After adding this element, double-click it to dene its
aributes. See Edit Entry Point Aributes.
 

Scheduled Entry Point
 

Drag and drop this element to create an entry point to the campaign based on a
recurring schedule. After adding this element, double-click it to dene its aributes. See
Edit Scheduled Entry Point Aributes.
 

Standard Elements
 

Standard elements perform actions when specied criteria are met.
 

Add to List
 

Drag and drop this element to add the contact to a list. After adding this element,
double-click it to dene its aributes. See Edit Add to List Aributes.
 

Transactional Mailing
 

Drag and drop this element to send a transactional mailing to the contact. After adding
this element, double-click it to dene its aributes. See Edit Transactional Mailing
Aributes.
 

Set Field
 

Drag and drop this element to set one of the elds in the contact record. After adding
this element, double-click it to dene its aributes. See Edit Set Field Aributes.
 

Redirect to URL
 

Drag and drop this element to redirect the contact to a URL. After adding this element,
double-click it to dene its aributes. See Edit Redirect to URL Aributes.
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Opportunity
 

Drag and drop this element to create an opportunity from the contact record. After
adding this element, double-click it to dene its aributes. See Edit Opportunity
Aributes.
 

Notication
 

Drag and drop this element to send a notication to one or more sta members.
After adding this element, double-click it to dene its aributes. See Edit Notication
Aributes.
 

Lead
 

Drag and drop this element to create a lead from the contact record. After adding this
element, double-click it to dene its aributes. See Edit Lead Aributes.
 

External Event
 

Drag and drop this element to run an external event. External events are scripts that run
outside of Oracle Service Cloud. After adding this element, double-click it to dene its
aributes. See Edit External Event Aributes.
 

Transactional Survey
 

Drag and drop this element to send a transactional survey to the contact. After adding
this element, double-click it to dene its aributes. See Edit Transactional Survey
Aributes.
 

Incident
 

Drag and drop this element to create an incident from the contact record. After adding
this element, double-click it to dene its aributes. See Edit Incident Aributes.
 

Execute Object Event Handler
 

Drag and drop this element to add a contact-related object event handler that will
trigger an external event action. See Edit Execute Object Event Handler Aributes.
 

Conditional Elements
 

Conditional elements produce multiple path outcomes based on decisions.
 

Case Statement
 

Drag and drop this element to add a case statement to the campaign. A case statement
is a type of conditional element that lets you add multiple choice decisions. This give
you an easy way to add diverse branching capabilities to your campaigns based on
conditions dened in the workow. Case statements are unique because they have an
outgoing path for every condition. As soon as the rst choice (condition) is matched, the
path for that choice is followed, and no other conditions within the case statement are
evaluated. See Connectors in Campaigns. After adding the case statement, double-click
it to dene its aributes. See Edit Case Statement Aributes .
 

Decision
 

Drag and drop this element to add a decision point. A decision lets you specify
conditions the contact must meet to advance in the workow. You can create two
outgoing paths from a decision: Yes (contact meets the criteria) and No (contact does
not meet the criteria). See Connectors in Campaigns. After adding the decision, double-
click it to dene its aributes. See Edit Decision Aributes.
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Artifacts
 

Artifact elements let you make comments about your campaign. They do not aect the
outcome of your ow diagram.
 

Comment
 

Drag and drop this artifact to add comments about your ow diagram or a specic
campaign component. A comment artifact does not require a connector, but if your
comment is about a specic element, use the Artifact connector type. See Connectors in
Campaigns.
 

2. To connect one element to another, click an anchor on the rst element and drag the connector to an anchor on
the second element.
The anchor is highlighted when the connector is able to link to it. The connector arrow will point from the rst
element to the second. See Connectors in Campaigns.

3. To change the formaing of an element, double-click the element, and then use the options on the Element
Tools tab.

Group/Buon Description

Label
 

The buons in this group let you change the font style, size, and color. You can select
font aributes, such as bold and italic, and change the text alignment.
 

(Label Position)
 

Click this buon to select the position of the label relative to the element. The default
label position of a new element is Inside.
 

 

Click this buon to type the text of the element label.
 
You can also edit the label text inline by clicking the element label.
 

Notes
 

Click this buon to type notes about the element.
 

Size
 

The buons in this group let you change the height and width of the element.
 

Tip:  To select multiple elements at the same time, press Ctrl and select each component.

4. To cut, copy, or paste one or more components, click the appropriate buon on the Clipboard group of the
Home tab.

5. To undo an action on the canvas, click Undo on the Quick Access toolbar.
6. To redo an action on the canvas, click Redo on the Quick Access toolbar.
7. To export an image of the canvas to your workstation, click File and select Export Image.
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Connectors in Campaigns  
Connectors are components used to link campaign elements and indicate ow direction. Elements can be connected to
other elements depending on their type. The type of connector is indicated by its color.

Connector Color Description

Yes
 

Green
 

This type of connector links a decision element to another element. The path is taken if the
contact meets the criteria specied in the decision.
 

No
 

Red
 

This type of connector links a decision element to another element. The path is taken if the
contact does not meet the criteria specied in the decision.
 

Standard
 

Gray
 

This type of connector links one element to another element. The second action is performed
immediately after the rst.
 

Artifact
 

Black (Dashed)
 

This type of connector links a comment to an element.
 

Submit
 

Blue
 

This type of connector submits the element web form elds to the database and then links to
another element. A web form can be a document with a web form or survey questions.
 
In order for the submit connector to work, there must be a submit action on the web form
that’s used in the campaign. See Insert a Survey Results Link.
 

Case
 

Gray
 

This type of connector links a case statement element to another element. The path is taken if
the contact meets the criteria specied in the case statement.
 

Each element can have a specic number of incoming and outgoing connectors. The following table details the type
and number of connectors allowed in each element.

Element Connectors Allowed

Add to List
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Broadcast Mailing
 

No incoming connectors
 
1 outgoing submit path
 

Case Statement
 

Unlimited incoming connectors
 
1 outgoing connector for each choice.
 

Decision
 

Unlimited incoming connectors
 
1 outgoing Yes connector
 
1 outgoing No connector
 

1534



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Element Connectors Allowed

Entry Point
 

No incoming connectors
 
1 outgoing standard connector
 

Execute Object Event Handler
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

External Event
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Incident
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Lead
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Notication
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Opportunity
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Redirect to URL
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Scheduled Entry Point
 

No incoming connectors
 
1 outgoing standard connector
 

Serve Web Page
 

Unlimited incoming connectors
 
1 outgoing standard connector (if incoming path exists)
 
1 outgoing submit connector
 

Set Field
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Transactional Mailing
 

Unlimited incoming connectors
 
1 outgoing standard connector
 
1 outgoing submit connector
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Element Connectors Allowed

 

Transactional Survey
 

Unlimited incoming connectors
 
1 outgoing standard connector
 
1 outgoing submit connector
 

Connect an Element  
Connectors are used to link elements and show ow direction. Elements can be connected to other elements depending
on their type. The type of connector is indicated by its color.

The anchor is highlighted when the connector is able to link to it. The connector arrow will point from the rst element
to the second. When you connect your element types this way, the system automatically applies the correct connector
type.

1. Click an anchor on the rst element and drag the connector to an anchor on the second element.

Note:  If you use the wrong connector type, the element anchor will not be highlighted.

Other ways to connect elements include the following:

◦ Hover over the rst element and click a blue arrow to link to an adjoining element.

◦ Drag one element over another, hover over its blue arrow until it turns dark blue, and then drop to
connect the elements. Connecting your elements this way auto-links them with the correct connector
type.

◦ Click an element from the toolbox, and then hover over an element on the canvas and click its blue arrow
to drop and auto-link the new element.

◦ Drag and drop a connector from the toolbox to the canvas, and then drag the ends of the connector to
the elements you want to link.

Related Topics
• Connectors in Campaigns

• Connectors in Surveys

Connect to a Dierent Element  
You can change the ow of your existing elements by moving a connector to a dierent element.

1. Click a midpoint on the connector to select it and drag one of its ends to an anchor on a dierent element.
The element will highlight when you can connect to it. Remember, if you try to use the wrong connector type,
your element will not be highlighted.

Edit a Square or Curved Connector  
You can adjust the shape of the connection on square and curved connectors.

These images show the calibration points on square and curved connectors.
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1. Click a midpoint on a square or curved connector to select it and drag the calibration points to change the
connection shape.

Delete a Connector  
You can delete connector components.

1. Click a midpoint on the connector to select it and press Delete.

Edit Serve Web Page Aributes  
After you add a Serve Web Page element to your ow diagram, you can edit its aributes to select a document to serve
as a web page through Oracle Service Cloud.

You can specify the shortcut ID used to generate the URL and choose whether to prell the web form in the document
with contact elds stored in the contact’s cookies or passed as parameters in the URL. You can also customize the title
of the page you are editing. The page title displays in the title bar of the web browser when the survey is taken.

Tip:  Use a submit connector to connect this action to the next action when the web page contains a web form
or survey questions. You can also add a back buon to a web page that contains a web form. See Add a Back
Buon to a Serve Web Page.

1. Double-click the Serve Web Page element.
The Serve Web Page window opens.

2. Enter the name of the element in the Label eld.
3. Enter eld information.

Field Description

*Documents
 

Select the document you want to use as a web page from this list.
 
To search for a document, right-click the list and select Search. Then enter the
document name in the Find eld.
 

New Document
 

Click this text to create a document. See Create a Document.
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Field Description

*Shortcut ID
 

Enter the shortcut ID that is used to format the URL in this eld. The URL for the
document will be:
 
hp://<your_domain>/ci/documents/detail/2/<shortcut_ID>
 

Note:  This shortcut ID must be unique for all Serve Web Page elements in all
surveys and campaigns.

(View Web Page)
 
 

Click this icon to open the web page in a browser.
 
The icon is inactive until the campaign is launched. If the shortcut ID is edited after
launching, the icon is inactive until the campaign is saved.
 

Copy URL
 

Click this icon to copy the web page URL to the clipboard.
 
The URL will not be valid until the campaign is launched.
 

*Friendly Name
 

Enter the name of your web page. This name is used when linking to the web form from
another document.
 

Title
 

Enter the name of the page as you want it to display in the title bar of the web browser
when the survey is taken.
 
If you leave this eld blank, either the document title or the template title will display in
the web browser title bar. If a template has been applied to the document the web page
uses, then the template title is used.
 

4. Click the User Identication tab.
You can specify default values for the seings on the User Identication tab by editing optional conguration
seings. See Customize Feedback Conguration Seings.

5. Enter eld information.

Field Description

Identify User By
 

Select from the following options to prell a web form (if one is included in your
document).
 

Login with Password
 

Select this option to require the contact to log in to the customer portal before viewing
the web form.
 

Remember Previous Login
 

Select this check box to identify the contact through the contact’s Oracle Service Cloud
login cookie. If a login cookie does not exist, the contact is redirected to the login page
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Field Description

on the customer portal. If this check box is cleared, the contact is always required to log
in through the customer portal before viewing the web form.
 

Other Credentials
 

Select this option to identify the contact by a cookie or through URL parameters.
 

Cookie
 

Select this option if you want to use the contact’s browser cookie to prell the web form.
The contact’s record is updated with the form submission.
 

Email Click-Through Parameters
 

Select this option if you want to use parameters passed in the URL to prell the web
form.
 

Tip:  If using this option to prell a web form from a link in a mailing, be sure
to use a web page link instead of a tracked link. Because tracked links are used
to redirect to external sites, they do not support click-through parameters.

Do Not Identify
 

Select this option if you do not want the web form to prell. This applies only to single
page surveys or campaigns with only one Serve Web Page element. For surveys and
campaigns with more than one page, after the contact info is added to the rst page,
 the subsequent pages will prell. Therefore, this option applies only to the rst instance
of a page in a survey or campaign ow that uses a Submit connector.
 
For example, most surveys use a Submit connector on the rst page that ows to the
next page with another Submit connector, and so on. In this case, the rst page will not
prell since the contact has not been identied. However, after the rst page has been
submied, the next page that loads will be associated to that contact. Therefore, any
web form elds on that page (as well as on subsequent pages) will prell even though
Do Not Identify is selected.
 

Note:  A contact record is updated through the web form if the email address
eld is included and can be matched to an existing record.

Set Browser Cookie on Submit
 

Select this check box if you want to set the contact’s browser cookie upon submiing
the form. If the contact accesses any form later, the form will be prelled if the Cookie
option is selected for that form.
 

Tip:  You can set default values for the user identication elds by editing the conguration seings
located in Outreach and Feedback/General/Campaigns. Note that default values specied by these
seings impact both new campaigns and new advanced surveys.

6. To add any notes associated with the element, click the Notes tab and enter the notes.
7. Click OK.
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Edit Broadcast Mailing Aributes  
After you add a Broadcast Mailing element to your ow diagram, you can edit its aributes to dene which mailing to
send.

You can choose to create a mailing or use an existing mailing in your database. See Create a Broadcast Mailing.

Tip:  Use a submit connector to connect this element to the next element when the mailing contains a web
form.

1. Double-click the Broadcast Mailing element to open the Broadcast Mailing window.

2. Enter the name of the element in the Label eld.
3. Select the mailing you want to send from the list.

a. To search for a mailing, right-click the list and select Search. Then enter the mailing name in the Find
eld.

4. To create a broadcast mailing, click New Broadcast Mailing.

Note:  When adding a new broadcast mailing to a campaign, you cannot send or schedule the mailing
until you save the campaign.

5. To add any notes associated with the element, click the Notes tab and enter the notes.
6. Click OK.

Edit Scheduled Entry Point Aributes  
After you add a Scheduled Entry Point element to your ow diagram, you can edit its aributes to schedule regular runs
of a campaign for a designated segment.

When launched, a scheduled campaign can be edited, suspended, rescheduled, or canceled at any time. Information
about past runs—such as the time last run, next scheduled runtime, the time the schedule was last updated, and basic
results data—is stored in the knowledge base and tracked in the Recurring Campaigns Summary report. Also, each
recurrence is tracked in the campaign audit log along with a description of how many contacts were processed. See
Audit Logs.

1. Double-click the Scheduled Entry Point element to open the Scheduled Entry Point window.

Note:  To avoid conicts, campaigns may contain only one Scheduled Entry Point. Those containing a
Scheduled Entry Point cannot contain a broadcast mailing and cannot be selected to run automatically
when using the Data Upload Wizard.

2. Enter the name of the entry point in the Label eld.
3. Enter eld information.

Field Description

Recurrence Paern
 

Select the weekly or monthly interval for the campaign to be launched. For example, a
mailing can be sent every two weeks on Tuesday, or every month on the 7th and 19th.
 

Clear All
 

Click this text to clear all selected recurrence paern check boxes.
 

Monthly
 

Select this option to display check boxes for the days of the month. You can then select
the days of the month when you want to send the campaign.
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Field Description

 

Weekly
 

Select this option to display check boxes for each day of the week. You can then select
the check boxes next to the days when you want to send the campaign.
 
When you select this option, a Recur drop-down menu displays where you specify the
frequency of the weekly mailing or survey. For example, if you want to send a mailing
every week on the days selected, enter 1 in the eld. If you want the mailing to be sent
every third week on the days selected, enter 3 in the eld. This eld accepts values from
1 to 99.
 

Schedule Specic Months
 

Click this header to display check boxes for the months of the year. Select the months
during which you want to send the campaign. By default, every month is selected, but
if you do not want to send during a specic month, you can clear the check box for that
month.
 

Clear All
 

Click this text to clear all check boxes for the selected months.
 

Range of Recurrence
 

Options in this section let you specify a date range for the recurrence and time of day to
send the campaign.
 

Start
 

Enter the start date of the schedule or click the calendar to open a calendar from which
you can select the start date. The current day is the default start date.
 

End
 

Enter the end date of the schedule or click the calendar to open a calendar from which
you can select the end date.
 

Time to execute campaign
 

Enter the time of day to begin sending the campaign.
 

4. Click the Segment tab and select the segment you want the campaign to act on.
a. To exclude contacts from the segment that were included in a previous instance of the recurrence, select

Exclude Previous Match.
b. To create a new segment, click New Segment.

5. Click the Properties tab and enter the shortcut ID of the entry point in the Shortcut ID eld.
This value is used to identify the entry point and must be unique for each campaign.

6. Enter the name of the entry point in the Friendly Name eld.
7. To add any notes associated with the entry point, click the Notes tab and enter the notes.
8. Click OK.

Edit Entry Point Aributes  
After you add an Entry Point element to your ow diagram, you can edit its aributes to dene its name and shortcut.
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The shortcut can be passed as a parameter to send contacts through the campaign, beginning at the entry point. The
entry point can also be used when contacts are uploaded using the Data Import Wizard. See Import Data.

1. Double-click the Entry Point element to open the Entry Point window.
2. Enter the name of the entry point in the Label eld.
3. Enter the shortcut ID of the entry point in the Shortcut ID eld.

This value is used to identify the entry point and must be unique for each campaign.
4. Enter the name of the entry point in the Friendly Name eld.
5. Select Create Outreach Activity Record to record a transaction when a contact enters the ow diagram at an

entry point.
This can be used to report on the entry point in outreach activity reports, including on the Outreach Activity tab
when editing a contact record.

6. To add any notes associated with the entry point, click the Notes tab and enter the notes.
7. Click OK.

Edit Add to List Aributes  
After you add an Add to List element to your ow diagram, you can edit its aributes to dene which list the contact is
added to. You can select from predened lists in your system or create a list.

1. Double-click the Add to List element to open the Add to List window.
The Add to List window opens.

2. Enter the name of the element in the Label eld.
3. Select a contact list from the List tab.

a. To search for a contact list, right-click the list and select Search.
b. Enter the list name in the Find eld.

4. To create a contact list, click New Contact List and see Add a Contact List.
5. To add any notes associated with the element, click the Notes tab and enter the notes.
6. Click OK.

Edit Transactional Mailing Aributes  
After you add a Transactional Mailing element to your ow diagram, you can edit its aributes to dene which mailing
to send to a contact. In addition, you can choose to send the mailing immediately, at an exact time, or at a certain
interval.

If the mailing is scheduled to be sent at a certain interval, it is stored until the mailer daemon sends it. By default, the
mailer daemon sends scheduled transactional mailings every fteen minutes. If you want the utility to send mailings
more frequently, you must edit the RNMD_EVENT_PROC_INTERVAL conguration seing.

Note:  The Transactional Mailing element simply schedules a mailing to be sent. It does not pause the
processing of the ow until the mailing is sent. Therefore, any elements following this element in the ow
continue to be processed immediately, even if the mailing is scheduled to be sent in the future.

This element can be ltered using segments. If you choose to lter a transactional mailing, you can select whether
contacts who are in or not in the segment will be sent an email.

1. Double-click the Transactional Mailing element.
The Transactional Mailing window opens.

2. Enter the name of the element in the Label eld.
3. Select the mailing you want to send.

a. To search for a mailing, right-click the list and select Search. Then enter the mailing name in the Find
eld.
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Note:  In order to send a transactional mailing, it must be in a launched state. If you select a
transactional mailing that has not been launched, it does not send and the system advances to the
next element in your ow diagram.

4. To create a transactional mailing, click New Transactional Mailing. See Create a Transactional Mailing.
5. Click the Schedule tab.
6. Enter eld information.

Field Description

Immediately
 

Select this option to send the email immediately after the action occurs.
 

At exact time
 

Select this option and click the calendar (to the right of the date eld) to select a specic
date and time to send the email.
 
If this option is selected, a clock icon appears on the Transactional Mailing element to
indicate that a delivery time for the mailing is scheduled.
 

Wait
 

Select this option to send the mailing a specied amount of time after the action is
triggered in the ow. Use the up and down arrows to select the number of units, and
click the drop-down menu to select the interval (minutes, hours, days, or weeks).
 
If this option is selected, a clock icon appears on the Transactional Mailing element to
indicate that a delivery time for the mailing is scheduled.
 

7. Click the Filter tab to select whether or not contacts should be included in the segment to be ltered from the
mailing.
The default is Send This Mailing Only to People in the Following Segment. If you leave the default, only contacts
who meet the criteria in the segment receive the mailing.

8. Select the Filter this Mailing check box.
9. Click the drop-down menu and select whether or not customers in the segment will receive the mailing.

10. Select a segment for the mailing.
11. To add a segment, click New Segment and see Create a Segment.
12. To add any notes associated with the element, click the Notes tab and enter the notes.
13. Click OK.

Edit Set Field Aributes  
After you add a Set Field element to your ow diagram, you can edit its aributes to specify the value of contact elds.
You can specify a number of dierent eld values, including opt-in status, state, or any contact custom elds dened in
your system.

1. Double-click the Set Field element.
The Set Field window opens.

2. Enter the name of the element in the Label eld.
3. Click the Field drop-down menu and select the contact eld you want to set the value of.
4. To add a new contact custom eld, click Add New Custom Field and see Add or Edit a Custom Field.
5. Enter a value for the contact eld you selected.
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Note:  In addition to seing explicit (absolute) values, you can set null values for text and text
area elds as well as relative values for some eld types. Relative values are dened by adding or
subtracting (or appending or prepending) a value to the previous value of the eld. See Relative Field
Values.

6. To add any notes associated with the element, click the Notes tab and enter the notes.
7. Click OK.

Relative Field Values  
In addition to seing absolute eld values for date, date/time, integer, text, and text area elds, you can set relative
values.

When seing a value for one of these eld types, clicking the Value drop-down menu presents additional options for
adding or subtracting (or appending or prepending) a value to the previous value of the eld. For example, you can
increment the value of an integer eld by 1 or append text to a contact text eld. For date and date/time elds, you can
also set a value relative to the time of action, such as adding one day to the current date and time.

Options for seing relative eld values vary by eld type.

Field Type Value Options

Date
 

Add or subtract a number of days or weeks to or from the previous value or the current date.
 

Date/Time
 

Add or subtract a number of minutes, hours, days, or weeks to or from the previous value or the
current date and time.
 

Integer
 

Add or subtract an integer value to or from the current value.
 

Note:  The resulting value cannot be greater than the maximum value dened for the eld
or less than the minimum. Therefore, the maximum value you can add or subtract is the
maximum value minus the minimum value of the eld. For example, if the eld maximum is
8 and the eld minimum is -8, the maximum value you can add or subtract from the current
value is 16.

Text Field
 

Prepend or append a text value to the current text value.
 

Text Area
 

Prepend or append a text value to the current text value.
 

Edit Opportunity Aributes  
After you add an Opportunity element to your ow diagram, you can edit its aributes to dene elds of the
opportunity created by this element.

You can specify the opportunity’s name, status, strategy, stage, assigned sales representative, and territory.
1. Double-click the Opportunity element.

The Opportunity window opens.
2. Enter the name of the element in the Label eld.
3. Enter eld information.
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Field Description

*Name
 

Enter the name of the opportunity in this eld.
 
The contact’s email address is appended to the lead name.
 

*Status
 

Click this drop-down menu to assign a status to the opportunity.
 

Strategy
 

Click this drop-down menu to assign the opportunity to a strategy.
 

Stage
 

Click this drop-down menu to assign the opportunity to a stage. The options in this
menu depend on the strategy selected.
 

Assigned
 

Click this drop-down menu to assign the opportunity to a sales representative. Use
the Find eld at the boom of the Assigned drop-down menu to quickly locate sta
members.
 

Tip:  Wildcards are supported when searching sta members. You can search
strings that include a space by entering %+Space+character, which is
helpful when searching last names. For example, entering %+Space+b returns
all last names starting with the leer b. There is also an implied wildcard when
searching, so entering in the Find eld returns all items containing the leer b.

Territory
 

Click this drop-down menu to assign the opportunity to a territory.
 

Summary
 

Enter a summary of the opportunity in this eld.
 

4. Click Set Custom Field to set custom elds for the opportunity. The Set Custom Field window opens.

Note:  You must dene custom elds in the Custom Fields editor before you can set a custom eld for
an opportunity. See Add or Edit a Custom Field.

a. Click the Field drop-down menu to select the custom eld you want to set.
b. Enter the value of the custom eld in the Value eld.
c. Click OK.

The custom eld and its value appear in the Custom Fields grid.
5. To edit the value of a custom eld, click Edit next to the custom eld.
6. To remove the set value of a custom eld, click Delete next to the custom eld.
7. To add any notes associated with the element, click the Notes tab and enter the notes.
8. Click OK.

Related Topics
• How You Work with Opportunities
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Edit Notication Aributes  
After you add a Notication element to your ow diagram, you can edit its aributes to dene which sta members to
notify.

1. Double-click the Notication element.
The Notication window opens.

2. Enter the name of the element in the Label eld.
3. Enter the message you want to appear in the subject line of the notication in the Message eld.
4. Select the check boxes of the sta members you want to notify.
5. To add any notes associated with the element, click the Notes tab and enter the notes.
6. Click OK.

Edit Redirect to URL Aributes  
Redirect to URL elements let you dene a web page your customers are redirected to when they complete the previous
action in the workow. After adding a Redirect to URL element to your ow diagram, you can edit its aributes to
specify the URL you want to send the contact.

1. Double-click the Redirect to URL element.
The Redirect to URL window opens.

2. Enter the name of the element in the Label eld.
3. Enter the URL of the website you want to redirect the contact to in the URL eld.

The protocol must be specied. The following protocols are supported:

◦ le:///

◦ ftp://

◦ gopher://

◦ hp://

◦ hps://

◦ mailto:

◦ nntp:

◦ news:

4. To open the URL in a browser, click the Open URL icon (to the right of the URL eld).
5. To add a contact, incident, opportunity, or tracked link eld to the URL as a parameter, click the Merge Field

icon (to the right of the Open URL icon). See Insert a Text Merge Field.
6. To add any notes associated with the element, click the Notes tab and enter the notes.
7. Click OK.

Edit Transactional Survey Aributes  
After you add a Transactional Survey element to your ow diagram, you can edit its aributes to dene which survey to
send to a contact. In addition, you can choose to send the survey immediately, at an exact time, or at a certain interval.

If the survey is scheduled to be sent at a certain interval, the survey is stored until sent by the mailer daemon. By
default, the mailer daemon is scheduled to send scheduled transactional surveys every fteen minutes.

Note:  The Transactional Survey element simply schedules a survey to be sent. It does not pause the
processing of the ow until the survey is sent. Therefore, any elements following this element in the ow
continue to process immediately, even if the survey is scheduled to be sent in the future.
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This element can be ltered using segments. If you choose to lter a transactional survey, you can select whether
contacts who are in or not in the segment are sent an email.

1. Double-click the Transactional Survey element.
The Transactional Survey window opens.

2. Enter the name of the element in the Label eld.
3. Select the survey you want to send.

a. To search for a survey, right-click the list and select Search. Then enter the survey name in the Find eld.
In order to be sent, the transactional survey you select must be in a launched state. If you select a transactional
survey that has not been launched, it is not sent and the system advances to the next element in your ow
diagram.

4. To create a transactional survey, click New Transactional Survey. See Create a Segment.
5. Click the Schedule tab.
6. Enter eld information.

Field Description

Immediately
 

Select this option to send the survey invitation message immediately after this action
occurs.
 

At exact time
 

Select this option and click the calendar (to the right of the At Exact Time eld) to select
a specic date and time to send the invitation message.
 
If this option is selected, a clock icon appears on the Transactional Survey element to
indicate that a time has been scheduled for this invitation message.
 

Wait
 

Select this option to send the survey invitation message a specied amount of time
after this action is triggered in the ow. Use the up and down arrows to select the
number of units, and click the drop-down menu to select the interval (minutes, hours,
days, or weeks).
 
If this option is selected, a clock icon appears on the Transactional Survey element to
indicate that a time has been scheduled for this invitation message.
 

7. Click the Filter tab and select Filter This Survey to select whether contacts should be included or not included
in the segment to be ltered from the survey.
The default is Send This Survey Only to People in the Following Segment. If you leave the default, only contacts
who meet the criteria in the segment receive the survey.

8. To send the survey to all contacts except those who meet the criteria in the segment, click the drop-down menu
and select Send This Mailing to Everyone Not in the Following Segment.

9. Select a segment for the survey.
10. To add a segment, click New Segment.
11. To add any notes associated with the element, click the Notes tab and enter the notes.
12. Click OK.
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Edit Execute Object Event Handler Aributes  
You can add contact-related object event handlers to your campaign that can be associated with create and update
operations on contact objects. Object event handlers are added and managed on the process designer in a virtual
container called the process model.

You must add object event handlers from the process designer and then deploy the process model  before you can add
Execute Object Event Handler elements to your campaign.

After you add your object event handlers on the process designer and deploy the process model, you can add an
Execute Object Event Handler element to your ow diagram and then associate it with one your object event handlers to
trigger an action. See Add an Object Event Handler.

Note:  Only synchronous object event handlers are applicable to campaigns and surveys.

1. Double-click the Execute Object Event Handler element.
The Execute Object Event Handler window opens.
Contact objects must be added on the process designer and then the process model must be deployed for
objects to display on the List tab.

2. Enter the name of the element in the Label eld.
3. Select an object event handler from the List tab.
4. To add notes about the object event handler, click the Notes tab and enter your notes.
5. Click OK.

Edit Lead Aributes  
After you add a Lead element to your ow diagram, you can edit its aributes to dene elds of the lead created by this
element.

You can specify the status, strategy, stage, assigned sales representative, and territory of the lead.
1. Double-click the Lead element.

The Lead window opens.
2. Enter the name of the element in the Label eld.
3. Enter eld information.

Field Description

*Name
 

Enter the name of the lead in this eld.
 
The contact’s email address is appended to the lead name.
 

*Status
 

Click this drop-down menu to assign a status to the lead. Only statuses with a Lead
status type display. This eld is set to Lead by default.
 

Strategy
 

Click this drop-down menu to assign the lead to a strategy. Only strategies with a stage
assigned the Lead status type display.
 

Stage
 

Click this drop-down menu to assign the lead to a stage. The options in this menu
depend on the strategy selected.
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Field Description

 

Assigned
 

Click this drop-down menu to assign the lead to a sales representative. Use the Find
eld at the boom of the Assigned drop-down menu to quickly locate sta members.
 

Tip:  Wildcards are supported when searching sta members. You can search
strings that include a space by entering %+Space+character, which is
helpful when searching last names. For example, entering %+Space+b returns
all last names starting with the leer b. There is also an implied wildcard when
searching, so entering in the Find eld returns all items containing the leer b.

Territory
 

Click this drop-down menu to assign the lead to a territory.
 

Summary
 

Enter a summary of the lead in this eld.
 

4. Click Set Custom Field to set custom elds for the lead. The Set Custom Field window opens.

Note:  You must dene custom elds in the Custom Fields editor before you can set a custom eld for
a lead. See Add or Edit a Custom Field.

a. Click the Field drop-down menu to select the custom eld you want to set.
b. Enter the value of the custom eld in the Value eld.
c. Click OK.

The custom eld and its value appear in the Custom Fields grid.
5. To edit the value of a custom eld, click Edit next to the custom eld.
6. To remove the set value of a custom eld, click Delete next to the custom eld.
7. To add any notes associated with the element, click the Notes tab and enter the notes.
8. Click OK.

Related Topics
• How You Work with Leads

Edit Incident Aributes  
After you add an Incident element to your ow diagram, you can edit its aributes to dene the subject, status, and
other elements of the created incident.

1. Double-click the Incident element.
The Incident window opens.

2. Enter the name of the element in the Label eld.
3. Enter eld information.

Field Description

*Subject
 

Enter the subject of the incident in this text box.
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Field Description

*Status
 

Click this drop-down menu to select a status to assign to the incident. The default status
is Unresolved.
 

Assigned
 

Click this drop-down menu to select a group or sta member to assign to the incident.
Use the Find eld at the boom of the Assigned drop-down menu to quickly locate sta
members.
 

Tip:  Wildcards are supported when searching sta members. You can search
strings that include a space by entering %+Space+character, which is
helpful when searching last names. For example, entering %+Space+b returns
all last names starting with the leer b. There is also an implied wildcard when
searching, so entering in the Find eld returns all items containing the leer b.

Product
 

Click this drop-down menu to select a product for the incident.
 

Category
 

Click this drop-down menu to select a category for the incident.
 

Disposition
 

Click this drop-down menu to select a disposition for the incident.
 

Queue
 

Click this drop-down menu to select a queue for the incident.
 

Service Mailbox
 

Click this drop-down menu to select a mailbox to associate with the incident.
 

Customer Entry
 

Enter a default value for the customer thread in this text box.
 

Private Note
 

Click this tab to enter a default value for the notes thread.
 

4. Click Set Custom Field to set custom elds for the incident. The Set Custom Field window opens.

Note:  You must dene custom elds in the Custom Fields editor before you can set a custom eld for
an incident. See Add or Edit a Custom Field.

a. Click the Field drop-down menu to select the custom eld you want to set.
b. Enter the value of the custom eld in the Value eld.
c. Click OK.

The custom eld and its value appear in the Custom Fields grid.
5. To edit the value of a custom eld, click Edit next to the custom eld.
6. To remove the set value of a custom eld, click Delete next to the custom eld.
7. To add any notes associated with the element, click the Notes tab and enter the notes.
8. Click OK.
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Related Topics
• Overview of Incidents

Add a Comment  
The toolbox also provides a Comment artifact that allows you to enter comments in your diagram without impeding
the campaign or survey ow. Comments are added to the canvas in the same way elements are and can be linked to
elements using the Artifact connector type.

1. Drag and drop a Comment artifact from the toolbox onto the canvas.
2. Click the artifact to type your comments.
3. To connect the artifact to an element, click an anchor on the artifact and drag to an anchor on the element.

The anchor is highlighted when the connector is able to link to it.

Edit Case Statement Aributes  
Case statements help you branch your workow based on multiple conditions you dene. They are unique because
you dene an outgoing path for each condition. When the rst choice (condition) is matched, the path for that choice is
followed, and no other conditions within the case statement are evaluated.

After you add a case statement element to your ow diagram, you can edit its aributes to branch your ow to dierent
paths based on whether contacts meet certain conditions. When you edit the case statement, you can dene multiple
conditions using a contact eld in the database, a question, or a score.

Score pertains to the cumulative score from all preceding survey question responses. Score always displays on the
Cases tab.

Case statements dier from decisions because they let you add multiple paths to your ow. This image shows a case
statement with four choices that lead to three dierent paths.

1. Double-click the Case Statement element.
The Case Statement window opens.

2. Select a contact eld, survey question, or score from the Cases tab.

Tip:  Depending on the item you select, choices are either already dened by default or you must
dene them.

3. If you want to add an “other” path to your case statement, select Include Option for Other.
4. To add a choice that is not dened by default, click Add Choice.
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The boom section of the Case Statement window displays options to dene logical expressions for your
choices.
The Add Choice buon does not display if choices have already been dened by default. For example, Contact
Type or Global Opt-in under Default Contact Fields have choices dened. Therefore, the Add Choice buon
does not display when these elds are selected.

5. Click the Operator drop-down menu to select the logical symbol that completes your expression.
6. Enter the eld value in the Choice eld.
7. To add another choice that is not dened by default, repeat steps 4 through 6.
8. To delete a choice, select the choice and click Remove.
9. To add a choice that is dened by default, select the check boxes next to the choices you want to include in your

case statement.
Cases with menu, yes/no, and opt-in items present you with default choices dened by the database.

10. To add any notes associated with the element, click the Notes tab and enter the notes.
11. Click OK.

Edit Decision Aributes  
Decision elements let you branch your workow based on two outgoing paths you dene.

After you add a Decision element to your ow diagram, you can edit its aributes to require contacts to meet certain
criteria before moving down the Yes path. Contacts who do not meet the criteria are moved down the No path (if one
exists). When you edit the decision, you can dene conditions based on contact elds or question responses and a
logical expression based on the conditions.

When you create decisions in campaigns or advanced questionnaires, you can create branches in your survey based
on customer response. For example, you could serve a document with survey questions as a web page, then create a
decision based on a response to send them to one of two documents containing additional questions.

Also, when a matrix question is added to an advanced questionnaire, each question from the matrix can be ltered by
decision elements. In this way, you can direct the ow based on a specic contact response to an individual question in
the matrix.

1. Double-click the Decision element to open the Decision Conditions window.
2. Enter the name of the decision in the Label eld.
3. Click Add Condition to create a condition for the Yes path. The Add Condition window opens.

a. Enter the name of the condition in the Name eld.
b. Click the Source drop-down menu and select a database eld or survey question.

Note:  When adding a text eld to a decision, the Source drop-down menu displays an additional
item as “<text eld name> SmartSense.” Selecting the Smart Sense item lets you evaluate the
customer’s emotional state or aitude based on the words or language the customer used when
responding to the question. You can then specify values from Very Happy to Very Angry as
criteria for your decision logic.

c. Click the Operator drop-down menu and select the logical symbol that completes the condition.
d. Enter the value of the eld or click the drop-down menu and select the value in the Value eld.
e. Click OK to add the condition to the decision.

This expression determines which contacts meet the condition (for example, State/Province=MT or
<menu question>=<specied answer>).
By default, when multiple conditions are added, they are joined by AND. When the AND operator is used,
contacts are moved down the Yes path when all the conditions are met. You can further limit your data
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set by using the Boolean operators OR and NOT. When the OR operator is used, contacts are moved
down the Yes path when any of the conditions are met.

4. To add an OR to your expression, click Add OR Node.
Conditions aached to the OR node are joined by OR.

5. To edit a condition, select the condition and click Edit Condition.
6. To delete a condition, select the condition and click Remove Condition.

The Add OR Node, Edit Condition, and Delete Condition options display only after you have added a condition.
7. Click View Text Denition to see your conditions as a logical expression.
8. To add any notes associated with the element, click the Notes tab and enter the notes.
9. Click OK.

Edit External Event Aributes  
External events have been deprecated and may be permanently removed in a future release. Instead, you can use
contact-related object event handlers to trigger actions.

For information about external events or contact-related object event handlers, contact your Oracle account manager.
See Edit Execute Object Event Handler Aributes.

Choose an Existing Design  
When creating a new campaign, there may be times when you want to start with a ow diagram that was previously
designed for another campaign.

This can be accomplished by making a copy of an existing campaign to create your new campaign. When you copy a
campaign to create your design, you can also choose to copy element aributes from the original or start with empty
aributes. You can then make changes and additions to the new campaign without impacting the original.

1. Click New to open the Geing Started section to select a starting point for your campaign.

2. Click Choose Existing Campaign.
The Choose Existing Campaign window opens.

3. Select the campaign you want to use.
4. To select how the campaign is inserted, click Show Advanced Options.

a. To copy the element aributes of the campaign diagram, including labels and other elds, select Full
Copy.
Broadcast mailing IDs and shortcut IDs will not be copied, as these values must be unique.

b. To copy the campaign diagram without its element aributes, select Empty Copy.
After copying, you will need to edit each element to enter its aributes.

5. Click OK.

Tip:  Outreach also provides a number of predened campaign templates that support common
business processes. See Apply a Campaign Template.

Campaign Validation  
As you create a ow diagram for your campaign, Outreach validates all ow components to ensure all required
aributes have been specied. Although validation occurs in real time as you add and update the components, you can
also force validation manually by clicking Validate on the Home tab.

You can choose to display validation ags by selecting the Validation Results check box on the View tab. This way, valid
components are agged with a green check mark, while those found to be invalid are agged with a red exclamation
point and a small buon you can click to view the validation error. If you aempt to launch a campaign without rst
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addressing its validation errors, the ags automatically display (even if you have not selected the Validation Results
option) along with a message summarizing the errors.

Related Topics
• Campaign Design Ribbon View Tab

• Campaign Design Ribbon Home Tab

Launch or Suspend a Campaign  
After you have designed and validated your campaign, you must launch it to make it active. After a campaign has been
launched, you can suspend it and relaunch it at a later time.

1. To launch or relaunch the campaign, click Launch on the Home tab.
a. Click OK to save the campaign in a launched state.

2. To suspend the campaign, click Suspend.
a. Click OK to save the campaign in a suspended state.

3. Click Save.

Note:  When you suspend a campaign, you do not suspend all of the mailings or surveys that are
associated with the campaign. You are simply preventing new contacts from entering the ow. If you
want to suspend mailings that are included in the campaign ow, you must do so from the mailings or
surveys.

View Campaign Results  
The content pane displays a report listing the type of transactions that have occurred over the life of the campaign,
sorted by the number of instances.

In addition to the campaign results, Outreach features a variety of reports for viewing detailed campaign performance
statistics.

1. Click Results on the Home tab.

A report opens.

Related Topics
• How You View Reports

Campaign Management  
In addition to the ow diagram, campaigns can be further dened by a variety of other conguration options, including
campaign objectives, tasks, notes, and le aachments. You can also view an audit log to see when a campaign was
created and edited.

This section describes how to create objectives and tasks for your campaign. For information about notes, le
aachments, and the audit log, see Overview of Common Functionality.
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Set Campaign Details  
The campaign details seings let you assign a campaign to a sta member, set start and end dates, and dene
campaign objectives. After a campaign is launched, this section also displays a report listing opportunities generated by
the campaign.

1. Click Details on the Home tab.
The campaign details display on the content pane.

2. To assign the campaign to another sta member (by default, the campaign is assigned to the sta member
who creates it), click the Assigned drop-down menu and select the sta member.

a. To search for a sta member, enter the sta member’s name in the Find eld.

Tip:  Wildcards are supported when searching sta members. You can search strings that include
a space by entering %+Space+character, which is helpful when searching last names. For example,
entering %+Space+b returns all last names starting with the leer b. There is also an implied wildcard
when searching, so entering b in the Find eld returns all items containing the leer b.

3. Click the calendar next to the Start Date eld to select the date the campaign is scheduled to start.
4. Click the calendar next to the End Date eld to select the date the campaign is scheduled to end.

Note:  The Start Date and End Date elds are for planning purposes only. They do not aect campaign
launch or suspend dates. See Launch or Suspend a Campaign.

5. Enter a description of your campaign objectives in the Objectives Summary text box.
You can use the seings in the Objectives section to track key aributes of the campaign, such as its budget, its
expected cost, and the number of leads the campaign is expected to generate. When you know the actual cost
and sales of your campaign, you can enter those gures as well, and the system uses them to calculate cost per
lead, cost per opportunity, net prot, and return on investment (ROI).

6. Enter eld information.

Field Description

Budget
 

Enter the amount budgeted for the campaign, select the currency used, and click the
Exchange Rates icon to select the exchange period.
 

Expected Cost
 

Actual Cost
 

Enter the expected cost of the campaign, select the currency used, and click the
Exchange Rates icon to select the exchange period. When the campaign ends, enter the
actual cost of the campaign.
 

Expected Sales
 

Actual Sales
 

Enter the expected amount of sales resulting from the campaign, select the currency
used, and click the Exchange Rates icon to select the exchange period. When the
campaign ends, enter the actual amount of sales resulting from the campaign.
 

Expected Leads
 

Enter the number of leads expected to be generated from the campaign.
 

Actual Leads
 

This eld displays the actual number of leads generated from the campaign through the
Lead element.
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Field Description

 

Expected Opportunities
 

Enter the number of opportunities expected to be generated from the campaign.
 

Actual Opportunities
 

This eld displays the actual number of opportunities generated from the campaign
through the Opportunity element.
 

Expected Cost Per Lead
 

Actual Cost Per Lead
 

These elds display the expected cost per lead, and when the campaign ends, the actual
cost per lead. The values are calculated by dividing the expected cost by the expected
leads.
 

Expected Cost Per Opportunity
 

Actual Cost Per Opportunity
 

These elds display the expected cost per opportunity, and when the campaign ends,
 the actual cost per opportunity. The values are calculated by dividing the expected cost
by the expected opportunities.
 

Expected Net Prot
 

Actual Net Prot
 

These elds display the expected net prot, and when the campaign ends, the actual
net prot. The values are calculated by subtracting the expected cost from the expected
sales.
 

Expected ROI
 

Actual ROI
 

These elds display the expected return on investment, and when the campaign ends,
 the actual return on investment. The values are the percentage dierence between the
expected cost and expected sales.
 

7. To view data associated with campaign objectives, you can view the Opportunities by Stage report located
below the objectives section. For information about this report, click the Options drop-down menu and select
View Denition.

8. Click Save.

Add a Task to a Campaign  
To manage other work related to a campaign, you can create and assign tasks to yourself and other sta members. You
can then track the overall progress of those tasks by viewing their due date and completion percentage.

This section describes the options available for creating and assigning tasks.
1. Click Tasks on the Home tab.

The Tasks section opens on the content pane.
2. Enter eld information.

Buon Description

Tasks Click this buon to display a drop-down menu containing the following options.

1556



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Buon Description

   

Add New
 

Select this option to add a new task. See Add a Task for the procedure to complete the
elds on this window.
 

Add Existing
 

Select this option to add an existing task. After nding and selecting a task, the task is
added to the task list for the campaign. See Search for a Task from an Open Record.
 

Open
 

Click this buon to open the selected task for editing.
 

Print
 

Click this buon to print the selected task.
 

Copy
 

Click this buon to copy the selected task.
 

Delete
 

Click this buon to permanently delete the selected task.
 

Remove
 

Click this buon to remove the selected task from the campaign (without deleting the
task).
 

Complete
 

Click this buon to mark the selected task completed.
 

Forward
 

Click this buon to open the Task Forward window and send the task to specic
recipients.
 

Options
 

Click this buon to select an option for managing the output and display of information
on the tab, such as print, forward, or export. See How You Change Report Formaing for
information about other options, such as Auto Filter, Slice, Cross Tab, and Rollups.
 

Related Topics
• Overview of Common Functionality

• Add a Task

• Search for a Task from an Open Record

Apply a Campaign Template  
Outreach provides several predened templates as a starting point for creating your campaign ow diagram. When you
choose a template, the elements and connectors associated with that template are added to your diagram.
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You can add and remove elements to further customize your campaign. You then open each element to assign its
aributes and congure it to meet your business needs.

1. From the Template group of the Insert tab, hover over each template buon to see a preview on the content
pane.
A tooltip displays a description of the template.

◦ Ad Conversion—This template updates a contact submied through a web form to create a lead if the
contact is interested in the promotion. See Ad Conversion.

◦ Email Promotion—This template sends a broadcast email and actions are taken based on a contact’s level
of interest. See Email Promotion.

◦ Event Registration—This template sends an invitation to an event and uses a web form for registration.
See Event Registration.

◦ Information Request—This template is used to gather information about contacts through a
questionnaire. See Information Request.

◦ Subscription Management—This template allows contacts to update their subscription preferences. See
Subscription Management.

2. Click a template buon to add the template to the canvas.
A message opens warning you that selecting a template overwrites the existing content on the canvas.

3. Click OK.
The template is inserted in the diagram.

4. Double-click each element to edit its aributes.
5. Click Save.

Related Topics
• Create a Campaign Flow Diagram

Ad Conversion  
The Ad Conversion template uses a web form to determine if a contact is interested in a promotion or product. Based on
the web form, the contact record is either updated to set a eld, or the contact is converted to a sales lead.

Component Description

Conversion Form
 

This Serve Web Page element starts the campaign. Double-click the element to select or create a
document that uses a web form to determine customer interest.
 

Interested?
 

This conditional element determines which path contacts should follow based on their interest.
Double-click the element to choose a contact eld to base the decision on.
 

Lead
 

This element creates a lead from the contact record for contacts who are interested. Double-click the
element to set elds associated with the lead.
 

Update Contact
 

This element updates the contact record if the customer is not interested. Double-click the element to
choose which contact eld to update.
 

Email Promotion  
The Email Promotion template sends a broadcast email and actions are taken based on a contact’s level of interest in
the promotion. The broadcast email sends a link to a web form.
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Based on two levels of interest (ready to buy and interested), the customer is either sent to the purchase page, added as
a lead to Opportunity Tracking, or added to a contact list and sent a follow-up email.

Component Description

Promotion
 

This element sends a broadcast mailing to contacts inviting them to click through to the conversion
form. Double-click the element to select or create a mailing that links to the conversion form.
 

Conversion Form
 

This element serves a document as a web page. Double-click the element to select or create a
document that uses a web form to determine customer interest.
 

Ready to Buy?
 

This conditional element determines the path contacts should follow based on whether they are ready
to buy the product. Double-click the element to choose a contact eld to base the decision on.
 

E-Commerce
 

This element serves a document as a web page to contacts who are ready to buy. Double-click the
element to select or create a document as a sales form.
 

Interested?
 

This conditional element determines the path contacts should follow based on interest. Double-click
the element to choose a contact eld to base the decision on.
 

Lead
 

This element creates a lead from the contact record for contacts who are interested. Double-click the
element to set elds associated with the lead.
 

List
 

This element adds contacts who are not interested to a contact list. Double-click the element to select
or create the list you want to add the contacts to.
 

Follow-Up
 

This element sends a transactional mailing to contacts who are not interested as a follow-up. Double-
click the element to select or create a mailing and decide when to send it and how to lter it.
 

Event Registration  
The Event Registration template sends an invitation to an event and uses a web form for registration.

When contacts register, they are added to a list and receive emails to thank them, conrm their registration, and remind
them of the event. Contacts who do not register are sent a thank you email and an email to follow up.

Component Description

Invitation
 

This element sends a broadcast mailing to contacts inviting them to click through to the registration
form. Double-click the element to select or create a mailing that links to the registration form.
 

Registration Form
 

This element serves a document as a web page. Double-click the element to select or create a
document that uses a web form to register contacts for an event.
 

Registered?
 

This conditional element determines which path contacts should follow based on whether they
registered for the event. Double-click the element to choose a contact eld to base the decision on.
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Component Description

Thank You (Yes path)
 

This element serves a document as a web page to contacts who registered for the event. Double-click
the element to select or create a document as a thank-you page.
 

Aendee List
 

This element adds contacts who registered for the event to a contact list. Double-click the element to
select or create the list you want to add the contacts to.
 

Conrmation
 

This element sends a transactional mailing to contacts to conrm their registration. Double-click the
element to select or create a mailing as a conrmation.
 

Reminder
 

This element sends a transactional mailing to contacts who registered to remind them of the event.
Double-click the element to select or create a mailing as a reminder and decide when to send it.
 

Thank You (No path)
 

This element serves a document as a web page to contacts who did not register for the event. Double-
click the element to select or create a document as a thank-you page.
 

Follow-Up
 

This element sends a transactional mailing to contacts who did not register as a follow-up. Double-click
the element to select or create a mailing and decide when to send it and how to lter it.
 

Information Request  
The Information Request template is used to gather information about contacts through a questionnaire. Contacts are
sent a broadcast mailing inviting them to ll out a web form. After submiing the web form, contacts are redirected to a
thank you page and then sent a follow-up email.

Component Description

Connect
 

This element sends a broadcast mailing to contacts inviting them to ll out the web form. Double-click
the element to select or create a mailing that links to the questionnaire.
 

Questionnaire
 

This element serves a document as a web page. Double-click the element to select or create a
document that uses a web form to gather contact information.
 

Thank You
 

This element serves a document as a web page to contacts who submied the questionnaire. Double-
click the element to select or create a document as a thank-you page.
 

Follow-Up
 

This element sends a transactional mailing to contacts who submied the questionnaire. Double-click
the element to select or create a mailing and decide when to send it and how to lter it.
 

Subscription Management  
The Subscription Management template lets contacts update their subscription preferences. Contacts can update their
information through a web form. After submiing the web form, they are redirected to a web page that conrms their
submission and then sent a transactional mailing as additional conrmation.
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Component Description

Subscription Form
 

This element serves a document as a web page. Double-click the element to select or create a
document that uses a web form to gather contact information.
 

Conrmation (Serve Web Page)
 

This element serves a document as a web page to contacts who submied the subscription form.
Double-click the element to select or create a document as a conrmation page.
 

Conrmation (Transactional Mailing)
 

This element sends a transactional mailing to contacts who submied the subscription form. Double-
click the element to select or create a mailing and decide when to send it and how to lter it.
 

Note:  In addition to using predened campaign templates, you can reuse ow diagrams from previously
created campaigns. See Choose an Existing Design.

Customize Outreach and Feedback Conguration Seings  
Outreach provides many options that can be enabled by editing conguration seings. These seings are used to set
cookie expiration times, dene default values for Serve Web Page element properties, and specify whether documents
can be edited after having been sent in a mailing.

You can also dene the subject line of Forward to Friend emails and specify a default URL to load in cases where a blank
page would display.

1. Expand Site Conguration, and then double-click Conguration Seings.
The Search window opens, where you can lter your search results.

2. Clear the Select All check box under Folders and then select Outreach and Feedback.
3. To search for a specic conguration seing in the Outreach and Feedback folder, enter the seing name in the

Key eld. (The Key eld is not case sensitive.)
You can search part of a conguration seing name by appending a wildcard (either an asterisk or a percentage
sign) to the end of your search term.

4. Click Search.
The Conguration Seings editor displays the seings that match your search criteria. To display conguration
seings in alphabetical order, click in the Key column header.

5. Expand the folders under Outreach and Feedback/General.
6. Customize the seings in the specic Campaigns and Miscellaneous folders.

For information about a seing, see the description that appears on the Conguration Seings editor. For
complete details about the Conguration Seings editor, including searching, editing, and creating new
conguration seings, see Edit a Conguration Seing.

Related Topics
• Overview of Site Conguration
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Feedback Questions  

Overview of Questions  
Before you create surveys in Oracle RightNow Feedback Cloud Service (Feedback), you must rst create the questions
that your respondents will answer. You can choose dierent question types to gather responses of dierent qualities,
and you can customize display characteristics of each question.

For example, you can provide space for your respondents to enter their answers in their own words, returning data that
is often specic and insightful. Alternatively, you can oer respondents a choice of prewrien answers to a question,
which provides you with a consistent, easily interpreted data set. You can also score choice questions and use Oracle
RightNow Analytics Cloud Service (Analytics) to evaluate responses as numerical values.

While some types of question may be more useful than others based on your needs, any combination of question types
can be added to a survey. By presenting questions that are concise and meaningful, you can ensure that the feedback
you receive will be clear and actionable.

Related Topics
• Best Practices for Writing Eective Questions

Best Practices for Writing Eective Questions  
When writing a question, it is important to respect your respondents’ time and be clear about the information you
are requesting. The following best practices can help you optimize survey completion rates while obtaining the most
meaningful respondent feedback.

• Adopt an engaging tone—Speak respectfully to respondents. The more welcoming your language, the more
likely your audience is to complete each question.

• Use common words—Choose your words carefully. To ensure comprehension and accuracy, it is best to assume
that your respondents are not familiar with industry jargon and complex terminology. (One eective rule of
thumb is to write for a sixth-grade reading level.)

• Keep questions specic and short—State each question in a way that is meaningful to your respondents and
your analysis. Rephrase questions that are vague or verbose. When creating a choice question, clearly dene its
lowest and highest values. For example, on a scale of 1 to 5, what 1 means and what 5 means.

• Understand the goal of each question—Rene your questions to provoke the answers most meaningful to your
analysis. A well-framed question increases the signicance of your data.

• Limit the number of questions—Include only questions that are essential to your goal. If two questions would
return similar answers, combine them to eliminate the redundancy. If you must include several questions that
are similar in form and content, consider creating a matrix question  to save space. When creating choice and
matrix questions, keep the number of answer selections to a minimum while still accommodating all possible
answers.

• Spell check your questions—Remember to spell check your questions using the Spelling option available on the
ribbon.

How Questions Work  
Feedback provides a exible set of features for creating questions to add to your surveys.
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When you create a survey question, you dene the question name, type, and text that respondents see on the surveys.
You can also assign a score to each question choice. There are three question types.

• Create a Text Question

• Create a Choice Question

• Create a Matrix Question

Note:  Questions can be edited after they have been created, even if they have been used in a survey.
However, if you edit the question text or choices, those changes appear immediately in any survey it has been
included in. For this reason, if you want to preserve the integrity of the data returned by the original question,
we recommend creating a new question rather than editing the existing question.

Create a Text Question  
Text questions let respondents enter their answer to the question.

You can create text questions when you want your respondents to be able to answer in their own words without having
to choose from predened options. For example, “Do you have any suggestions?” When you create a text question, you
dene only the question and the available space the respondent has to answer.

1. From the Questions explorer, click New.
A new question opens on the content pane.

Tip:  You can also create questions from an open question by clicking New. Additionally, if your
navigation set is congured to add questions from the le menu, click  File > Surveys > Question .
See Congure the File Menu.

2. Enter the text of the question in the Question Text eld. This will be the question you want the respondent to
answer. For example, “How can we improve our service?”

3. Select Text from the Question enter drop-down menu.
4. Enter eld information.

Field Description

Respondent must answer this
question
 

Select this check box to require the respondent to answer the question. The survey
cannot be submied without answering the question.
 

Number of characters the
respondent may use to answer
 

Enter or use the arrows to select the number of characters the respondent can enter into
the answer eld. The maximum value is 4,000 characters, and the minimum value is 1
character. The default is 4,000 characters.
 

Number of lines to display to the
respondent
 

Enter or use the arrows to select the number of lines in the answer eld. The maximum
value is 30 lines, and the minimum value is 1 line. The default is 3 lines.
 

Number of columns to display to the
respondent
 

Enter or use the arrows to select the width of the answer eld. The maximum value is
125 columns, and the minimum value is 1 column. The default is 40 columns.
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Field Description

Display real time character count
 

Clear this check box to remove the real-time character count that displays to survey
respondents when they enter a text response. This check box is selected by default.
 

5. Click Display Options on the ribbon to dene HTML properties for the question and answer.
The Display Options window opens.

6. Enter eld information.

Field Description

Question Text Display Options
 

Enter information in this section to dene how the question text appears in the survey.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class
 

Enter any HTML style and class aributes you want to assign to the question text in
these elds. Style and class aributes dene how the text appears, such as color and
font. For example, color: red; font-weight: bold; font-style: italic.
 

Answer Text Display Options
 

Enter information in this section to dene how the answer text appears in the survey.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class
 

Enter any HTML style and class aributes you want to assign to the answer text in these
elds. Style and class aributes dene how the text appears, such as color and font. For
example, color: red; font-weight: bold; font-style: italic.
 

Counter Options
 

Enter information in this section to dene the appearance of the real-time character
count that displays to respondents.
 

Counter Default Color
 

Click the color box to select a default color for the counter text or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

Counter Warning Color
 

Click the color box to select a warning color for the counter text or enter the HTML
hexadecimal value of the color in the eld to the right of the color box. The warning
color is used when the number of characters in the answer eld exceeds the maximum
value allowed.
 

7. Click OK.
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8. To preview the question before saving it, click Preview Question on the ribbon. The Question Preview window
opens.

a. Click OK.
9. To spell check your question, click Spelling.

10. Click Save.
The Save As window opens where you can select the folder you want to save the question in and enter the
name of the question in the Name eld.

11. Click Save.

Create a Choice Question  
Creating choice questions let you dene the available responses for the question, allowing respondents to choose their
answer from a menu, radio buon, check box, or list. Choice questions may be scored and evaluated in Analytics.

1. From the Questions explorer, click New.
A new question opens on the content pane.

Tip:  You can also create questions from an open question by clicking the New buon. Additionally, if
your navigation set is congured to add questions from the le menu, click  File > Surveys > Question
. See Congure the File Menu.

2. Enter the text of the question in the Question Text eld. This will be the question you want the respondent to
answer. For example, “Which of the following products did you purchase?”

3. Select Choice from the Question Type drop-down menu.
Choice is the default question type.

4. Click the Display As menu and select one of the following question display types:

◦ Radio—The choices appear as options following the question. Respondents can select only one of the
predened choices to answer the question.

◦ Checkbox—The choices appear as check boxes. Respondents can select as many check boxes as you
dene.

◦ Menu—The choices appear in a drop-down menu. Respondents click the drop-down menu to select one
of the predened choices to answer the question. Menu is the default for Choice questions.

◦ List—The choices appear in a list. Respondents can select as many list items as you dene to answer the
question.

Note:  The question display type aects which elds display in the Choices section.

5. Enter eld information.

Field Description

Respondent Selections
 

Select whether respondents are required to answer this question and set the minimum
and maximum number of choices respondents can select.
 

Respondent must answer this
question
 

Select this check box to require respondents to answer the question. The survey cannot
be submied without answering the question.
 

Minimum
 

Type the minimum or maximum number of choices respondents must select in these
elds or use the up and down arrows to select a number. The minimum number cannot
be more than the maximum number.
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Field Description

Maximum
 

 
These elds display only for List and Checkbox choice types.
 

Add Choice
 

Click this buon to add a choice to the choice list.
 

Choices Panel
 

The choices panel displays all choices dened for the question. You can drag and drop
the choices to reorder the list.
 

Choice Text
 

Enter the text of the choice in this eld.
 

Score
 

Enter the score for the choice in this eld or use the up and down arrows to select a
number. The score value is used to assign a relative weight to each choice based on the
contact’s answers. Survey scores may be used as rule conditions or to trigger survey
nal actions. See Add an Action with the Survey Final Action Wizard.
 

Is “Other” Choice
 

Double-click this eld and then click the drop-down menu and select Yes to set the
choice to “other.” This lets respondents enter an additional choice in the list.
 
Only one choice can be set to “other” when the question is saved.
 

Action
 

This column displays actions that can be taken on choices.
 

Edit
 

Click this buon to edit the choice in the choice list.
 

Remove
 

Click this buon to remove the choice from the list.
 

 

Click the up or down arrow to move the selected choice one position higher or lower in
the list.
 

Randomize Choices
 

Select this check box to indicate whether the choices display to respondents in a
random order. If the check box is not selected, the choices display in the order in which
they are listed in the choice list.
 

Number of choices to display per
line
 

Enter the number of choices to display per line in this eld or use the up and down
arrows to select a number.
 
This eld displays only for Radio and Checkbox choice types.
 

6. Click Display Options on the ribbon to dene HTML properties for the question and answer.
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The Display Options window opens.
7. Enter eld information.

Field Description

Question Text Display Options
 

Enter information in this section to dene how the question text appears in the survey.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class
 

Enter any HTML style and class aributes you want to assign to the question text in
these elds. Style and class aributes dene how the text appears, such as color and
font. For example, color: red; font-weight: bold; font-style: italic.
 

Answer Text Display Options
 

Enter information in this section to dene how the answer text appears in the survey.
These aributes are applied to the listed choices for the question.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class
 

Enter any HTML style and class aributes you want to assign to the answer text in these
elds. Style and class aributes dene how the text appears, such as color and font. For
example, color: red; font-weight: bold; font-style: italic.
 

8. Click OK.
9. To preview the question before saving it, click Preview Question on the ribbon. The Question Preview window

opens.
a. Click OK.

10. To spell check your question, click Spelling.
11. Click Save.

The Save As window opens where you can select the folder you want to save the question in and enter the
name of the question in the Name eld.

12. Click Save.

Create a Matrix Question  
In cases where a series of questions can be responded to with the same set of answer choices, matrix questions can
help streamline survey appearance by grouping the questions together in a table.

Answer choices are displayed using either radio buons (to permit only one answer to each question) or check boxes
(to allow more than one answer). If you choose radio buons, you can restrict selections to one choice per row, forcing
respondents to rank their answers.

1. From the Questions explorer, click New.
A new question opens on the content pane.
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Tip:  You can also create questions from an open question by clicking the New buon. Additionally, if
your navigation set is congured to add questions from the le menu, click  File > Surveys > Question
. See Congure the File Menu.

2. Select Matrix from the Question Type drop-down menu.
3. Enter the introductory text for the matrix in the Introduction Text eld.

This text summarizes the group of questions in the matrix. For example, “Please rank your service experience
in the following areas.”

4. Enter eld information.

Field Description

Display As
 

Click this drop-down menu to select how answer choices are displayed. Options include
Radio or Checkbox. Radio is the default.
 
The question display type aects which elds display in the Matrix section.
 

Respondent Row Selections
 

These seings dene whether matrix questions are required and the number of
answers that can be selected per question.
 

Respondent must answer each
question
 

Select this check box to require respondents to answer each of the questions in the
matrix. The questionnaire cannot be submied without answering all of the listed
questions.
 

Minimum
 

Maximum
 

Enter the minimum or maximum number of choices respondents must select in these
elds or use the up and down arrows to select a number. The minimum number cannot
be more than the maximum number.
 
These elds display only for Checkbox choice type.
 

Example
 

This is a sample to illustrate the position of questions and choices in a matrix table. This
example does not display table, cell, or border styles dened in the display options, nor
does it display questions or choices that have been added to the lists.
 

Questions Panel
 
 

The question list displays all questions dened for the matrix. You can drag and drop
the questions to reorder the list.
 

Add Question
 

Click this buon to add a question to the matrix.
 

Question Text (Row)
 

This column displays the question text. Question text entries appear as labels in the
rows of the matrix table.
 

Action This column displays actions that can be taken on questions.
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Field Description

   

Edit
 

Click this buon to edit the question.
 

Remove
 

Click this buon to remove the question.
 

 

Click the up or down arrow to move the selected choice one position higher or lower in
the list.
 

Choices Panel
 

The choice list displays all choices dened for the matrix. You can drag and drop the
choices to reorder the list.
 

Add Choice
 

Click this buon to add a choice to the matrix.
 

Choice Text (Column)
 

This column displays the choice text. Choice text entries appear as labels in the columns
of the matrix table.
 

Score
 

Enter the score for the choice in this eld or use the up and down arrows to select a
number. The score value is used to assign a relative weight to each choice and allows
for survey calculations to trigger rules or campaign actions based on the respondent’s
answers. For information about using rules with survey results, see Last Survey Score
eld description under Incident Conditions. See also Add a Rule.
 

Action
 

This column displays actions that can be taken on choices.
 

Edit
 

Click this buon to edit the choice.
 

Remove
 

Click this buon to remove the choice.
 

 

Click the up or down arrow to move the selected choice one position higher or lower in
the list.
 

Randomize Rows
 

Select this check box to display the questions in the matrix in a random order. If the
check box is not selected, the questions display in the order in which they are listed in
the list of questions.
 

Forced Ranking
 

Select this check box with radio buon choices to restrict survey respondents to select
only one choice per column. This option is useful when designing a matrix containing
rows of items that you want your respondents to rank. Since matrix questions with
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Field Description

radio buons allow only one choice to be selected per row, the additional restriction on
columns forces respondents to rank their answers.
 

Note:  When Forced Ranking is selected, the matrix must contain the same
number of rows (questions) as it does columns (choices).

5. Click the Display Options buon on the ribbon to dene HTML properties for the question and answer.
The Display Options window opens.

6. Enter eld information:

Field Description

Introduction Display Options
 

Enter information in this section to dene how the introduction text appears in the
survey.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class
 

Enter any HTML style and class aributes you want to assign to the introduction text
in these elds. Style and class aributes dene how the text appears, such as color and
font. For example, color: red; font-weight: bold; font-style: italic.
 

Question Display Options
 

Enter information in this section to dene how the question text appears in the matrix.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class
 

Enter any HTML style and class aributes you want to assign to the question text in
these elds. Style and class aributes dene how the text appears, such as color and
font. For example, color: red; font-weight: bold; font-style: italic.
 

Choice Display Options
 

Enter information in this section to dene how the choice options appear in the matrix.
These aributes are applied to the listed choices for the question.
 
Style and class must be dened in a CSS le that is available on your web server and
linked to in the <head> tag of a survey template.
 

HTML Style
 

HTML Class

Enter any HTML style and class aributes you want to assign to the choice options in
these elds. Style and class aributes dene how the text appears, such as color and
font. For example, color: red; font-weight: bold; font-style: italic.
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Field Description

 

Table Properties
 

Dene the table aributes in this section.
 

Border
 

Enter the width, in pixels, of the table border or use the up and down arrows to select a
number.
 

Alignment
 

Click this drop-down menu and select the alignment of the table on the page. Your
choices are Left, Centered, and Right.
 

Width
 

Enter the width of the table, or use the up and down arrows to select a number, and
select the unit from the radio buons (Pixels or Percentage).
 

Header Repeat by Rows
 

Enter the number of rows after which the header row will be repeated, or use the up and
down arrows to select a number.
 

Dark Background Color
 

Click the color box to select a color for the dark background or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

Light Background Color
 

Click the color box to select a color for the light background or enter the HTML
hexadecimal value of the color in the eld to the right of the color box.
 

Border Color
 

Click the color box to select a color for the table borders or enter the HTML hexadecimal
value of the color in the eld to the right of the color box.
 

Cell Properties
 

Dene the table aributes in this section.
 

Cell Spacing
 

Cell Padding
 

Enter the spacing and padding, in pixels, of the table cells or use the up and down
arrows to select a number.
 

7. Click OK.
8. To preview the question before saving it, click Preview Question on the ribbon. The Question Preview window

opens.
a. Click OK.

9. To spell check your question, click Spelling.
10. Click Save.

The Save As window opens where you can select the folder you want to save the question in and enter the
name of the question in the Name eld.

11. Click Save.
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Best Practices for Using Matrix Questions in Mobile Surveys  
When matrix questions display on small mobile devices (400 pixels wide or less), questions and choices automatically
reow to display vertically. Larger mobile devices, such as tablets (or when small devices are viewed in landscape mode),
are wide enough to display matrix questions horizontally, as they display on a desktop.

Instead of using matrix questions in your mobile surveys, consider adding a case section with conditional content using
runtime variables to the HTML content of your questionnaire. This way, you can show dierent content for mobile
devices from what you show for desktop mode. See How You Customize Surveys for Use on Mobile Devices.

Here is an example of how you could use a case section with conditional content for both variables to hide a matrix
question that wouldn’t be eective when viewed on a small mobile device.

Legend for image: 1. Choice style question displays for mobile 2. Matrix style question displays for desktop

You could accomplish the same eect by adding a conditional section for each variable. Either way, the important
takeaway is to create content for both variables on a single page. Otherwise, the variable for which no content is dened
will display a blank page.

Tip:  Remember to test and preview your survey in both mobile and desktop modes and on applicable mobile
devices and browsers to ensure your conditional sections work the way you intend them to.

Related Topics
• Mobile Surveys

Feedback Surveys  

Overview of Surveys  
Oracle RightNow Feedback Cloud Service (Feedback) contains exible tools for creating custom surveys in a variety of
formats. Surveys can be sent as mailings, served as web pages, or sent as events triggered by a campaign or business
rule.

After you have dened the questions you want to ask, you can easily present them to your audience in surveys. With
a wide range of formaing and customization options, including survey reminders, market testing, and full analytics
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integration for tracking results, surveys provide you with a powerful channel for inviting, gathering, and analyzing
customer feedback.

Related Topics
• How Questions Work

• Overview of Audiences

• Overview of Content Library

Create a Survey  
You can create four types of surveys, distinguished by invitation method. Although available features vary by invitation
method, every survey is presented through a web page and can be linked to from outside of Oracle Service Cloud.

• Broadcast surveys are used to send broadcast invitations to specied audiences at a time you choose.

• Transactional surveys send invitations triggered by events that you dene, such as an incident resolution or a
campaign action.

• Website link surveys rely on separate invitation delivery mechanisms, such as a link to the survey placed on a
web page.

• Polling surveys display as a single question on a customer portal page or any page that is external to the
customer portal, such as a “Poll of the Day.” After customers submit their response, they see a poll results chart
or a thank-you message.

With the exception of polling surveys, surveys can be added to workspaces, leing your agents complete surveys by
proxy (on behalf of contacts) during telephone interactions (see Proxy Surveys). Whatever methods you choose for
delivering surveys, the basic steps for creating them are the same.

Tip:  Keep in mind that if you want to use survey reminders, it is best to add them as a part of your initial
survey creation process because reminders are scheduled based on when the initial survey is sent. The survey
type (broadcast or transactional) also plays a role. For these reasons, we recommend implementing survey
reminders into your strategy from the start. See Add a Survey Reminder.

The following procedure assumes that you access the Surveys explorer from the Surveys navigation list. However, this
explorer might reside in another navigation list.

1. Click Surveys on the navigation pane and double-click Surveys Explorer.
2. Click New.

A new survey opens on the content pane.

Tip:  You can also create surveys from an open survey by clicking New. Additionally, if your navigation
set is congured to add surveys from the le menu, click  File > Surveys > Survey .

3. To create a broadcast survey, click Broadcast Survey and see Create a Broadcast Survey.
4. To create a transactional survey, click Transactional Survey and see Create a Transactional Survey.
5. To create a website link survey, click Website Link and see Create a Website Link Survey.
6. To create a polling survey, click Polling Survey and see Create a Polling Survey.
7. Click Save.

The Save As window opens where you can select the folder you want to save the survey in and enter the name
of the survey in the Name eld.

1573



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

8. Click Save.

Related Topics
• Congure the File Menu

Survey Delivery Statuses  
Your broadcast and transactional surveys must follow certain steps that are dened by the survey delivery status.
Delivery status indicates the current state of the survey as it progresses through the distribution process.

This table describes the delivery statuses for broadcast and transactional surveys and indicates whether the status is set
by a sta member action or updated automatically by the system.

Status Survey Type Description

Draft
 

Broadcast
Transactional
 

This is the preliminary status of a survey. When a survey is created, it is
automatically set to the Draft status. The status reverts to Draft if a sta
member unschedules a survey.
 

Scheduled
 

Broadcast
 

This status indicates a survey is ready to be sent at the scheduled send date and
time. When a sta member selects the send time, the survey is automatically set
to the Scheduled status.
 

Launched
 

Transactional
 

This status indicates a survey has been launched and can be included in a rule
or campaign. Sta members launch a survey by clicking Launch on the Delivery
tab.
 

Note:  By default, a launched survey can no longer be modied
or sent. This ensures that you can accurately track the content
you send your customers. You can, however, suspend the survey
invitation message, make edits, and then re-launch it. See Launch a
Transactional Survey.

Recurrence Scheduled
 

Broadcast
 

This status indicates a survey is scheduled for recurring runs. When a sta
member selects a recurrence paern, the survey is automatically set to the
Recurrence Scheduled status.
 

Preparing to Send
 

Broadcast
 

This status indicates a survey is about to be sent. The status changes to
Preparing to Send when a sta member clicks Send Now.
 

Sending
 

Broadcast
 

This status indicates a survey is currently being sent to customers. The system
automatically sets the survey status to Sending after the survey is done
preparing to send or at the date and time the survey is scheduled to send.
 

Suspended
 

Broadcast
Transactional
 

This status indicates a survey is temporarily suspended from the Sending
or Scheduled status. Sta members can change the status to Suspended by
clicking Suspend on the Delivery tab.
 

Expired
 

Broadcast
Transactional
 

This status indicates a survey has expired. Surveys can be set to expire based
on date or maximum number of responses. After the rst expiration criterion is
met, the status is set to Expired and cannot be changed. See Survey Expiration
Seings.
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Status Survey Type Description

Suspended by Error
 

Broadcast
Transactional
 

This status indicates a survey encountered an error and was suspended by the
system.
 

Canceled
 

Broadcast
Transactional
 

This status indicates a survey was manually canceled. Sta members can cancel
a survey by clicking Cancel Invitation Message on the Delivery tab.
 

Note:  By default, a canceled survey can no longer be modied or sent.
This ensures that you can accurately track the content you send your
customers. You can, however, copy a canceled survey, and then modify
and send the copied survey. See Cancel a Broadcast Survey Invitation
Message and Cancel a Transactional Survey Invitation Message.

Completed
 

Broadcast
 

This status indicates a survey was sent. The system automatically sets a survey
status to Completed from the Sending status.
 

Related Topics
• Access Broadcast Survey Delivery Options

• Access Transactional Delivery Options for Surveys

Survey Management  
When creating or editing a survey, the Summary tab provides a variety of survey management functions.

Most of these functions vary depending on the survey invitation method, but some can be used on any survey,
including the following.

• Changing the survey invitation method—Once you create a survey, you can change its invitation method type.
The invitation methods available are Broadcast, Transactional, Website Link, and Polling Survey. Broadcast
surveys with an active recurrence are labeled Recurring Broadcast Survey.

• Deactivating an active survey—When you change the survey status to Inactive, customers cannot submit
responses to the survey and receive a warning message when aempting to access the survey URL.

• Seing survey expiration—Customizing the availability of your surveys makes the feedback you receive from
your customers more timely and actionable, and therefore, more meaningful for your organization.

• Adding notes—You may want to add notes to a survey that are not sent to audience members. You can use
notes to provide additional information about the survey that can be viewed by sta members as they are
working with the survey.

• Adding tasks—You can assign new or existing tasks to surveys and edit, delete, and forward tasks to other sta
members. You can also view each task associated with the survey.

Other common functions available from the Summary tab include the ability to add le aachments or view the audit
log to see when the surveys and broadcast survey reminders were created and edited and when delivery statuses
changed.
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Change the Invitation Method of a Survey  
Survey invitation methods include broadcast, transactional, website link, and polling. After you create a survey, you can
change its invitation method type.

1. On the Summary tab of an open survey, click Change next to Invitation Method. The Select Invitation Method
window opens.

Note:  You can switch invitation methods only when the delivery status of the message is Draft and no
rules or campaigns reference the survey. See Survey Delivery Statuses.

2. Select Broadcast Survey, Transactional Survey, Website Link, or Polling Survey.
3. Click OK.

The survey invitation method changes to the type you select.

Deactivate a Survey  
When you change the survey status to Inactive, customers cannot submit responses to the survey and receive a warning
message when aempting to access the survey URL.

1. On the Summary tab of an open survey, click Deactivate next to Survey Status.
The Disable Survey window opens.

2. Click Yes to conrm you want to deactivate the survey.
The survey status changes to Inactive.

3. To reactivate the survey, click Activate.
The Activate Survey window opens.

4. Click Yes to conrm you want to activate the survey.

The survey status changes to Active.

Add a Note to a Document, Mailing, or Survey  
You can use notes to provide additional information about the content that can be viewed by sta members as they are
working with the document, mailing or survey.

1. On the Summary tab of an open document, mailing, or survey, click the Notes tab.
2. Click Add.
3. Enter the note text in the text eld.
4. To sort the notes by ascending or descending date, click the Sort drop-down menu and select the sort option.
5. To edit an existing note, click Edit next to the note.
6. To permanently delete a note, click Delete next to the note.

Add a Task to a Survey  
You can assign new or existing tasks to surveys and edit, delete, and forward tasks to other sta members. You can also
view each task associated with the survey.

1. On the Summary tab of an open survey, click the Tasks tab.
2. Enter eld information.

Buon Description

Add Click this buon to display a drop-down menu containing the following options.
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Buon Description

Add New
 

Select this option to add a new task. See Add a Task for the procedure to complete the
elds on this window.
 

Add Existing
 

Select this option to add an existing task. After nding and selecting a task, the task is
added to the task list for the survey. See Search for a Task from an Open Record.
 

Open Click this buon to open the selected task for editing.
 

Print Click this buon to print the selected task.
 

Copy Click this buon to copy the selected task.
 

Delete Click this buon to permanently delete the selected task.
 

Remove Click this buon to remove the selected task from the survey (without deleting the task).
 

Complete Click this buon to mark the selected task completed.
 

Forward Click this buon to open the Task Forward window and send the task to specic
recipients.
 

Options Click this buon to select an option for managing the output and display of information
on the tab, such as print, forward, export, or display options. See How You Change
Report Formaing for information about other options, such as Auto Filter, Slice, Cross
Tab, and Rollups.
 

Related Topics
• Overview of Common Functionality

• Add a Task

• Search for a Task from an Open Record

Survey Expiration Seings  
Because many surveys are needed for only a limited period of time, you can set an absolute date and time when a
survey automatically expires. In addition to an absolute expiration date, broadcast and transactional surveys can be set
to expire relative to the date you send the invitation message.

Relative expiration can help you capture feedback in a relevant time frame so that you can make decisions based on
your insight. Say you create a recurring survey that lters every day for new customers to gather feedback about why
your organization was selected. Also, you want to receive this feedback within 30 days. Since the survey is triggered
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daily, seing a relative expiration date instead of an absolute date keeps the survey active for all new customers, but
also sets an expiration date relative to the contact it is sent to. See Add or Edit a Recurring Broadcast Survey Schedule.

You can also set survey expiration based on the maximum number of survey responses you have received. For instance,
suppose you want to oer your customers an incentive for their feedback. You could oer a coupon to the rst 1,000
responses you receive. This option is available for all survey types, including survey by proxy.

In addition, you can customize the expiration message, per survey, that recipients receive if they try to take an expired
survey. This helps ensure your recipients know the right course of action to take when an expiration message displays.

Note:  After the rst expiration criterion is met, the survey status is set to Expired and the status cannot be
changed. Therefore, if you want to make changes to your expiration criteria, you must do it before the rst
criterion is met.

Set an Absolute Expiration Date  
Automatic survey expiration is useful when a survey is needed for a limited period of time.

If you set both an absolute expiration date and a relative expiration date, the criteria that is met rst triggers the survey
to expire. For a scenario illustrating when it can be useful to set both, see the example at the end of this procedure.

1. On the Summary tab of an open survey, click Edit next to Expiration Date or click the expiration date.
The Survey Expiration window opens.

2. Select Time to Expire Survey and then type the date and time you want the survey to expire or click the
calendar to select the date.

3. To expire a survey at the current date and time, click the calendar and then click Today – [Date].
4. To cancel an existing survey expiration date, click the calendar and then click No Value.
5. Click OK.

The Expiration Date eld displays the time and date the survey is scheduled to expire.
In rare cases, you may want to set both an absolute and a relative expiration date. Suppose you set an absolute
expiration for the last day of the year, but your survey is either transactional or recurring. In other words, either an event
triggers the survey to send or it is scheduled to send daily. You also want your survey to expire 30 days from the send
date. By seing both an absolute and a relative expiration, you ensure that you get your response within the 30-day
time frame or before the end of the year.

Set a Relative Expiration Date  
Broadcast and transactional surveys can be set to expire relative to the date you send the invitation message.

If you set both an absolute expiration date and a relative expiration date, the criteria that is met rst triggers the survey
to expire. For a scenario illustrating when it would be useful to set both, see the example at the end of the procedure Set
an Absolute Expiration Date .

1. On the Summary tab of an open survey, click Edit next to Expiration Date.
The Survey Expiration window opens.

2. Select Relative Expiration and then type the number of days you want to set the survey to expire after you
send the invitation message. The maximum number of days you can set a survey to expire is 365.

3. Click OK.
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The window closes and the Expiration Date eld on the Summary tab displays the number of days after you
send the invitation message that the survey is scheduled to expire.

• If a contact is past the rst page of a survey and the survey expires, the survey will be accepted (as long as the
contact nishes the survey in that session). This means there is a chance that responses will be logged after the
expiration date.

• For recurring surveys, only an absolute expiration date will expire an entire survey because relative expiration
applies only to the contact the survey is sent to. See Add or Edit a Recurring Broadcast Survey Schedule.

Set Expiration Based on Maximum Number of Responses  
You can set survey expiration based on the maximum number of survey responses you have received. This option is
available for all survey types, including survey by proxy.

If you set both an absolute expiration date and a relative expiration date, the criteria that is met rst triggers the survey
to expire. For a scenario illustrating when it would be useful to set both, see the example at the end of the procedure Set
an Absolute Expiration Date .

1. On the Summary tab of an open survey, click Edit next to Expiration Max Responses.
The Maximum Responses window opens.

2. Select Limit Responses and enter the maximum number of responses you want to allow.
The maximum number of survey responses you can dene is one million.

3. Click OK.
The window closes and the Expiration Max Responses eld on the Summary tab displays the maximum
number of responses dened, the number of responses received, and the number of responses that are still
allowed.

4. To update the number of received and remaining responses that display on the Summary tab, click Refresh on
the ribbon.

A response is counted as soon as the answer to the rst question is submied.

Customize the Expiration Message  
To help ensure your recipients know the right course of action to take when an expiration message displays, you can
customize the expiration message, per survey, that recipients receive if they try to take an expired survey.

1. On the Summary tab of an open survey, click Edit next to Expiration Message.
The Survey Expiration Message window opens.

2. Enter the message you want recipients to see if they try to take an expired survey in the Expiration Message
text box. You can use HTML tags in this text box.

Note:  If you do not dene your own survey expiration message, the system default message is used.

3. Click OK.

Survey Reminders  
Reminders prompt your audience to take the survey if they have forgoen about it or to nish it if they have already
started but have not yet submied it. This increases your participation rates and, ultimately, gives you more data about
your customer experiences.
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We recommend implementing survey reminders into your strategy from the start. For detailed information about how
to make survey reminders eective, see Best Practices for Creating Eective Survey Reminders.

For broadcast and transactional surveys, you can add up to four automatic reminder messages to create a sense of
urgency for customers to complete surveys within a time frame you specify.

The audience for survey reminders can include recipients who have not started the survey, recipients who have started
but have not completed the survey, or both. When a reminder is sent to a customer who has started the survey, the
survey page that the customer was on is the page that opens (as long as cookies are enabled on the customer’s
computer) when the customer comes back to nish the survey.

You can also exclude segments of your audience from your reminders. For example, suppose you have a customer who
unsubscribed from your list since the initial invitation message was sent. You could create a segment that uses a custom
opt-out eld in the lter criteria and then exclude that segment from your audience. See Create a Segment.

• Survey reminders apply global opt-in and external suppression list options to your reminder audience if
those options are selected on the Audience tab of your survey. However, even if recency and frequency of
communication options are selected for the initial audience, they are not applied to the reminder audience
because the scheduling and frequency options you dene for each reminder take precedence over any recency
and frequency options that may be selected for the initial survey audience.

• The system is designed to prevent duplicates by allowing only one reminder to be sent to the same audience on
the same day.

While there are two standard reports that apply to survey reminders (Survey Reminder Statistics and Broadcast
Response Timeline), you can use the audit log to track your broadcast survey reminders without needing to run a report.
When reminders are sent for broadcast surveys, a new row is added to the audit log, which is available on the survey
Summary tab.

Tip:  Survey reminders can be scheduled to send between 1 and 365 days after your initial invitation message
is sent. Since it takes at least one day before your rst reminder can be sent, be sure to take this time factor
into account when creating survey reminders.

Add a Survey Reminder  
Survey reminders increase your participation rates and, ultimately, give you more data about your customer
experiences. You can add up to four automatic reminder messages to broadcast and transactional surveys, creating a
sense of urgency for customers to complete surveys within a time frame you specify.

Keep in mind that after a reminder is sent, you cannot edit, proof, or delete that reminder. However, for transactional
surveys, you can suspend the reminder, make edits, and then re-launch it. See Survey Delivery Statuses.

1. From an open survey, click the Reminders tab.
You can send up to four reminder messages to your audience. From the toolbar, you can create a reminder, edit,
delete, and send proofs of your reminders.

Column Description

Name
 

This column displays the name of the survey reminder.
 

Subject
 

This column displays the email subject line for the message that is sent to your audience
about the survey reminder.
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Column Description

Audience
 

This column displays the recipients who are included in the reminder message
audience. Options available include the following:
 
Not Started—Sends the invitation message to recipients who have not submied any
pages of the survey.
 
In Progress— Sends the invitation message to recipients who have started but have not
completed the survey.
 
By default, both options are selected.
 

Reminder Days
 

This column displays the number of days after the initial invitation message was sent
that the reminder message will be sent.
 
The minimum value of this eld is 1 day and the maximum value is 365 days.
 

Status
 

This column displays the delivery status of the reminder. See Survey Delivery Statuses.
 
This column is available only for broadcast survey reminders.
 

2. Click New on the toolbar to add your rst reminder message.
The Survey Reminder window opens.

3. Enter the name of the reminder message in the Name eld.

Tip:  Be specic when naming your reminder messages to help keep track of the dierent reminders
you create. For example, “1st reminder sent 7 days after invite.”

4. Enter the number of days after the initial invitation message is sent that the reminder message will be sent in
the Reminder Days eld.
This value must be unique for each reminder that you add in order to prevent duplicates by allowing only one
reminder to be sent to the same audience on the same day.

5. Enter the subject your audience will see in the Subject eld.
6. To insert a merge eld into the subject line of your reminder message, click the Merge Field icon (to the right

of the Subject eld) and select the merge eld. For example, you could use the special eld, Survey Expiration
Date, to let your audience know when the survey expires. See Insert a Text Merge Field.

7. Dene your message text and any other content or formaing options for your reminder using either the HTML
editor or the Text editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-
Only Messages.

8. Click the Audience tab to dene the audience for your reminder. By default, both the Not Started and the In
Progress check boxes are selected in the Included section.

a. Clear the Not Started check box to send the reminder message only to recipients who have started the
survey.

b. Clear the In Progress check box to send the reminder message only to recipients who have not started
the survey.

9. To exclude a segment from the audience, click Add Segment in the Excluded section.
The Select Segment window opens where you can select segments you want to exclude.
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10. To edit a segment that is excluded from the reminder, click Open next to the segment name. See Add Filters to
a Segment.

11. To remove a segment from the Excluded section, click Remove next to the segment name.
12. To count the number of contacts who will receive the reminder, click Refresh in the Count section.

Note:  The Count section is available only for broadcast surveys and data is available only after the
survey reminder is sent.

13. Click OK.
The new reminder is added to the Reminders tab.

14. To add another reminder, click New on the toolbar and repeat steps 3 to 13.
15. To open a reminder for editing, select the reminder and click Open.
16. To delete a reminder, select the reminder and click Delete.
17. To copy a message to create another reminder, select the message and click Copy. You can then open the copy

and make your edits.
A document is automatically created and stored in the Automatically Generated folder in the Documents
explorer for every copy of a reminder message. Changes made to content in any of the copied reminder
messages are not shared with the original reminder message or subsequent copies. See Automatically
Generated Folders.

18. To send a proof of a reminder message, select the message and click Send Proof. See Send a Proof.

Best Practices for Creating Eective Survey Reminders  
To be most eective, survey reminders need to be a part of your initial survey creation process because reminders are
scheduled based on when the initial survey is sent. The survey type (broadcast or transactional) also plays a role.

• For broadcast surveys (with the exception of recurring broadcast surveys), you cannot add reminders after the
broadcast survey is sent.

• For transactional surveys, reminders will apply only to the invitation messages sent after the reminder has been
added. For example, if you have a transactional survey that has been triggered to send by an external event and
then you decide to add reminders, the reminders will start sending only after your next survey is triggered.

For these reasons, we recommend implementing survey reminders into your strategy from the start.

Other best practices for using survey reminders include the following.

• Add reminders quickly—An ecient way to add more than one reminder is to simply copy your rst reminder,
and then open each new reminder to edit the Name, Reminder Days, and Subject elds, as well as any message
text you may want to change.

• Plan message delivery timing—Since it takes at least one day before your rst reminder can be sent, be sure to
take this time factor into account when creating survey reminders.

• Protect your reputation—Even though you can add four survey reminders to each survey, be careful not to
overwhelm your customers with too many reminders. For example, if you’ve sent a survey that expires in seven
days, you probably don’t need to send four reminders. Seriously consider the appropriate number of reminders
to send for your specic situation. Otherwise, you risk harming your reputation with your customers.

• Track reminder success—View the eectiveness of survey reminders using our standard reports. See View
Survey Results.

◦ Survey Reminder Statistics—This report lets you see the total number of email messages that were sent,
viewed, and clicked (opened) for both the initial invitation message as well as for all of the reminders.
Being able to see both the viewed and clicked statistics lets you evaluate which reminder prompted the
customer to open the survey. In other words, which one was most eective. This report also returns the
number of emails that bounced.
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◦ Broadcast Response Timeline—This report lets you see trends by using a time line to show the peaks
and valleys in your survey response numbers. Available only for broadcast survey reminders, responses
received from the date the initial invitation message was sent through the date the survey was last
submied display on the report. It also shows both the number of survey invitations and the number
of reminders sent. (This report is not available on the Results tab if the broadcast survey is a recurring
survey or if it uses market testing.)

Mobile Surveys  
Surveys are automatically optimized for readability and touchscreen compatibility making them user-friendly on mobile
devices. Landing pages, including Thank You, Forward to Friend, and Unsubscribe, have also been optimized for mobile.

The system detects whether the survey is being taken on a mobile device or a standard web device, such as a desktop
or laptop. When a mobile device is detected, the survey is optimized so that taking it from that device is easy. For
example, text is larger so it is readable without needing to zoom into the page, and answer choices and buons are easy
to select with the touch of a nger.

Mobile optimization is enabled, by default, on the Survey Options window. See Set Survey Options.

Tip:  Because dierent mobile devices and browsers display surveys in dierent ways, we recommend testing
your surveys on applicable mobile devices and browsers before you launch them.

Preview Your Survey for Mobile  
See the way your survey looks on a mobile device as well as a desktop or laptop.

1. From an open survey, click Mobile on the ribbon.
The Mobile Preview window opens as it would display if viewed from a mobile device.

2. To see how the survey would look on a mobile device without mobile optimization applied, click Switch to
Desktop Mode at the boom of the Mobile Preview window.

3. Click OK.

How You Customize Surveys for Use on Mobile Devices  
Case sections and conditional sections using runtime variables can be added to the HTML content of your survey
questionnaire if you want to show dierent content for mobile devices from what you show for desktop mode.

For instance, you might want to use a smaller image at the top of your survey for mobile devices than the one you use
for surveys viewed on desktops. In another situation, you could use a case section to hide a lengthy matrix question
that might not be eective when viewed on a small mobile device.

This image shows the Conditional Section window with the Runtime Variable option selected.
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When using conditional and case sections with runtime variables, it’s important to remember the following.

• Mobile conditional sections are honored on a mobile device even if mobile optimization is disabled in your
survey.

• When using desktop and mobile runtime variables, we recommend that you create content for both variables
on one page. You can do this either with a conditional section for each variable, or by adding content that
appears for both variables. Otherwise, the runtime variable for which no content is dened will display a blank
page.

• If the mobile user selects the Switch to Desktop Mode link, available on the rst survey page, all content that
displays will be desktop content, even if a mobile device is being used. (Switch to Desktop Mode is available
only on the rst page of a survey.)

• Test and preview your survey in both mobile and desktop modes to ensure your conditional sections work the
way you intend them to.

Related Topics
• Mobile Surveys

• Best Practices for Using Matrix Questions in Mobile Surveys

• Insert a Case Section

• Insert a Conditional Section

Best Practices for Mobile Surveys  
Many factors need to considered, when designing surveys for use on mobile devices. Several of these factors are
addressed in this topic.

If a survey uses a template, the template is not applied when the survey is viewed on a mobile device because most
templates are not optimized for mobile. If you want to create an appropriately sized template to be used for mobile,
you could add HTML content with a conditional section for mobile runtime that included a smaller image. See How You
Customize Surveys for Use on Mobile Devices.

Mobile optimization automatically resizes fonts for a user-friendly mobile experience. Therefore, font size, even if you
modify the default seing, is ignored on mobile devices when mobile optimization is enabled.

Keep in mind that certain fonts are not supported or consistently displayed on every mobile device. The list of widely
supported fonts for most mobile devices includes the following.

• Arial

• Courier and Courier New

• Georgia (with the exception of Android)

• Helvetica

• Times and Times New Roman

• Trebuchet MS (with the exception of Android)

• Verdana

For basic surveys, class and style buon properties are ignored on mobile devices when mobile optimization is enabled.
However, you can modify buon properties on advanced surveys by using a WebDAV client to access your Customer
Portal le structure, and then opening the /cp/customer/assets/feedback folder to edit the mobile.css le. See
Overview of WebDAV and Customer Portal Folder Structure.
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When using case and conditional sections with runtime variables, it’s important to remember the following:

• Mobile conditional sections work when a mobile device is detected even if mobile optimization is disabled on
the survey.

• If the mobile user selects the Switch to Desktop Mode link, available on the rst survey page, all content that
displays will be desktop content, even if a mobile device is being used. (Switch to Desktop Mode is available
only on the rst page of the survey.)

• When using desktop and mobile runtime variables, we recommend that you create content for both variables
on one page. You can do this either with a conditional section for each variable, or by adding content that
appears for both variables. Otherwise, the runtime variable for which no content is dened will display a blank
page.

Mobile preview is a limited, browser-based preview that gives you a general idea of how your survey might look on a
smaller device when you are designing your survey from your desktop. With that in mind, always test your surveys on
applicable mobile devices and browsers before you launch them. See Preview Your Survey for Mobile.

Track mobile survey use by analyzing usage trends with our standard reports. In addition, the Mobile Survey Trends
Dashboard displays all three mobile survey reports in one place for easy analysis. See View Survey Results.

The three mobile survey reports (Mobile Survey Trend, Mobile Survey Browser Trend, and Mobile Survey Operating
System Trend) and the dashboard are located in Public Reports/Feedback/Survey Responses/Mobile Surveys. A
fourth report (Standard Versus Mobile Survey Trend), which is not included on the dashboard, is also located in public
reports (Feedback/Survey Responses).

• Mobile Survey Trend shows the number of mobile surveys started and completed over time as well as the
completion rate.

• Mobile Survey Browser Trend shows the number of mobile surveys submied per browser over time.

• Mobile Survey Operating System Trend shows the number of mobile surveys submied per operating system
over time.

• Standard Versus Mobile Survey Trend shows the number of surveys taken on a mobile device versus surveys
taken on a standard web device, such as a desktop. If no columns for mobile devices display on the report,
either the survey was not enabled for mobile optimization or no mobile devices were used to take the survey.

Because dierent mobile devices and browsers display surveys in dierent ways, we recommend testing your surveys
on applicable mobile devices and browsers before you launch them.

Proxy Surveys  
Any broadcast, transactional, or website link survey can be added to a workspace, leing your agents complete surveys
on behalf of contacts during telephone interactions. Surveys can be embedded in contact, organization, incident, or
opportunity workspaces by inserting a Survey By Proxy control.

Together with the advanced mode features Feedback provides, proxy surveys can be used to initiate more complex
processes, such as creating leads and tasks, seing contact eld values, sending sta notications, and triggering
external events. This makes proxy surveys useful for meeting a variety of key business needs.

• An incident-based proxy survey can be used by customer support agents to invite feedback about how a
support call was handled or assess interest in new service oerings.

• An organization-based or contact-based proxy survey can be used by marketing personnel to prequalify leads
and opportunities for the sales team or add contacts to segments based on their explicitly conrmed interests.
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• Opportunity-based proxy surveys can be used by sales reps to gather feedback about specic sales interactions
or assess how well a product ts a given area of need.

Related Topics
• Add a Control to the Design Space

Create a Broadcast Survey  
You can create a broadcast survey if you want to survey a group of contacts in your knowledge base.

You can create a broadcast survey if you want to survey a group of contacts in your knowledge base. Similar to mailings,
broadcast surveys are sent at a certain time to an audience you dene. A link to the survey is sent by email using your
own content or a previously dened document. See Create a Document. Customers can then click the link to complete
the survey.

Note:  The delivery and participation rates of survey invitation emails can be impaired by factors beyond the
scope of Feedback.

1. From the Surveys explorer, click New.
A new survey opens on the content pane.

Tip:  You can also create surveys from an open survey by clicking New. Additionally, if your navigation
set is congured to add surveys from the le menu, click  File > Surveys > Survey .

2. Click Broadcast Survey.
By default, the Summary tab is active. From here, you can review general information about the survey in the
At a Glance section, as well as manage survey notes, tasks, and aachments (see Survey Management). As you
create the survey, you move through each tab to complete the survey elements.

3. To assign the survey to another sta member (by default, the survey is assigned to the sta member who
creates it), click the Assigned drop-down menu and select the sta member.

a. To search for a sta member, enter the sta member’s name in the Find eld.

Tip:  Wildcards are supported when searching sta members. You can search strings that include
a space by entering %+Space+character, which is helpful when searching last names. For example,
typing %+Space+b returns all last names starting with the leer b. There is also an implied wildcard when
searching, so typing b in the Find eld returns all items containing the leer b.

4. To let customers answer the survey anonymously, select the Allow Anonymous check box.
Contact information is not required to answer the survey.
Selecting Allow Anonymous in your survey does not mean that all responses are anonymous. If a survey
invitation is sent to a contact or an Oracle Service Cloud cookie is detected on the contact’s computer, or the
survey itself contains an email address eld, Feedback aempts to use that information to identify the contact.
For information about using cookies to identify contacts, see Set Survey Options.

5. To let customers submit the survey more than once, select the Allow Multiple Submissions check box.
The Allow Multiple Submissions option is not visible for recurring surveys, which always allow multiple
submissions. However, recurring surveys can be congured to exclude contacts from the audience that were
included in a previous instance of the recurrence. See Add or Edit a Recurring Broadcast Survey Schedule.

6. Click the text in the At a Glance section to perform common survey functions.
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Field Description

Invitation Method
 

This eld displays the invitation method currently selected for the survey. Click Change
to change the method. See Change the Invitation Method of a Survey.
 

Survey Status
 

This eld displays whether the survey is active or inactive. Customers cannot submit
responses to an inactive survey and receive a warning message when aempting to
access the survey URL. See Deactivate a Survey.
 

Expiration Date
 

This eld displays the survey expiration date and time. By default, no expiration date is
set. See Set an Absolute Expiration Date  and Set a Relative Expiration Date .
 

Expiration Max Responses
 

This eld displays the number of responses a survey can accept. If set, this eld also
displays the number of responses received, as well as the number of surveys that are
still allowed. The maximum number of survey responses you can dene is one million.
See Set Expiration Based on Maximum Number of Responses.
 

Expiration Message
 

Click Edit to customize the survey expiration message. See Customize the Expiration
Message .
 
If you do not dene your own survey expiration message, the system default message is
used.
 

Questionnaire
 

This eld displays how many pages and questions are in the survey. Click Preview
Survey to preview the survey.
 

Responses
 

This eld displays how many surveys were started and completed by customers.
 

Audience Count
 

This eld displays the most current audience count and when the last count was
performed. Click Refresh to update the audience count.
 
To view the details of the audience count, click Details. See View Audience Count Details
in Surveys.
 

Market Testing
 

This eld displays the market testing mode of the survey. Click Change to change
market testing modes. See Activate Market Testing in Broadcast Surveys.
 

Proong
 

This eld displays the number of proofs that have been sent, approved, and rejected.
Click Send Proof Message to send a proof. See Send a Proof.
 

Delivery Status
 

This eld displays the delivery status of the survey and the number of emails sent and
delivered. See Survey Delivery Statuses.
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Field Description

 

7. Click the Questionnaire tab to add questions and HTML content to the survey. See Create a Questionnaire in
Basic Mode and Create a Questionnaire in Advanced Mode.

8. Click the Audience tab to dene an audience for the survey. See Dene the Broadcast Survey Audience.
9. Click the Invitation Message tab to create the message sent to the survey audience. See Create an Invitation

Message in Broadcast Surveys.
10. Click the Reminders tab to create automatic email messages that will prompt your customers either to start

taking the survey or to nish it if they have already started. See Survey Reminders.
11. Click the Proong tab to send a proof of the email for internal review before sending it to the entire audience.
12. Click the Delivery tab to select delivery options. See Access Broadcast Survey Delivery Options.
13. To view the reports associated with the survey, click the Results tab. See View Survey Results.
14. To preview the survey as it would be viewed on a standard web device, such as a desktop or a laptop, click

Standard on the ribbon.
The survey preview opens in a web browser.

Note:  If a survey contains an email address eld and you submit a value for the eld in the survey
preview, the form creates or updates contact records so that advanced survey functions can be tested.
For this reason, be sure to use only test contact addresses to avoid updating production contacts when
testing survey previews. Also, be careful not to use the preview survey URL in place of the URL of your
completed survey (described in step 16). Information submied on a preview survey is discarded and
has no eect on the data collected by the live survey. For identication purposes, each preview survey
displays a watermark to ensure it is not confused with a live survey.

15. To preview the survey as it would be viewed from a mobile device, click Mobile on the ribbon. See Mobile
Surveys.
Mobile preview is a limited, browser-based preview that gives you a general idea of how your survey might look
on a smaller device when you are designing your survey from your desktop. With that in mind, always test your
surveys on applicable mobile devices and browsers before you launch them.

16. To copy the URL of the survey to your clipboard, click Survey URL on the ribbon. The Survey URL message
opens.

a. Click OK when you are nished viewing the URL.
A URL is automatically assigned to the survey. This is the URL that your invitation message links to and your
customers visit to complete the survey. From this window, you can view the URL and it is automatically copied
to your workstation clipboard.

17. Click Save.

Related Topics
• Congure the File Menu

Dene the Broadcast Survey Audience  
Your survey audience can include and exclude a total of fty contact lists and segments, each containing a vast number
of contacts.

For example, you could include twenty-two segments of contacts and exclude twenty-eight contact lists for a total of
fty lists. You can also restrict the scope of your audience, set survey frequency and recency limits, and specify how to
handle global opt-in and suppression options. See Overview of Audiences for complete details and procedures about
using contact lists and segments in surveys and mailings.

1. From an open survey, click the Audience tab.
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2. To include a list in the audience, click Add Contact List in the Included section. The Select Contact List window
opens.

a. To add a contact list, click New Contact List and see Add a Contact List.
b. Select the list you want to include in the survey audience and click OK.

The list is added to the Included grid. Contacts belonging to the list receive the survey.
3. To include a segment in the audience, click Add Segment in the Included section. The Select Segment window

opens.
a. To add a segment, click New Segment and see Create a Segment.
b. Select the segment you want to include in the survey audience and click OK.

The list is added to the Included grid. Contacts belonging to the list receive the survey.
4. To exclude a list from the audience, click Add Contact List in the Excluded section. The Select Contact List

window opens.
a. Select the list you want to exclude from the survey audience and click OK.

The list is added to the Excluded grid. Contacts belonging to the list do not receive the survey.
5. To exclude a segment from the audience, click Add Segment in the Excluded section. The Select Segment

window opens.
a. Select the segment you want to exclude from the survey audience and click OK.

The segment is added to the Excluded grid. Contacts belonging to the segment do not receive the survey.
6. To edit a list or segment that is included in or excluded from the survey, click Open next to the list or segment

name. See How Contact Lists Work and How Segment Filters Work.
7. To remove a list or segment from the Included or Excluded sections, click Remove next to the list or segment

name.
8. Enter eld information about communication options.

Field Description

Honor global opt-in
 

Select this check box to send the survey to contacts who did not explicitly opt out of
receiving surveys or mailings. Clear this check box to send the survey to all contacts in
the audience, regardless of their opt-in preference.
 

Limit frequency of communication
 

Select this check box to set a frequency limit, then enter a maximum number of surveys
and mailings and a number of days in which contacts can receive messages before they
are excluded from surveys. The survey is not sent to any contacts who have received the
maximum number of surveys and mailings within the designated time period. For more
information about how this seing works, see Frequency and Recency Limits.
 
The minimum you can enter is 2 in the last 1 day. The maximum number of days you can
enter is 90.

Tip:  To ensure contacts receive only 1 email every “x” number of days, use the
Limit recency of communication seing described next.

 

Limit recency of communication
 

Select this check box to set a recency limit. Enter the minimum number of days that
should elapse before contacts receive another email. The survey is not sent to any
contacts who have received a survey or mailing email in the past specied number of
days. For more information about how this seing works, see Frequency and Recency
Limits.
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Field Description

 
The maximum number of days you can enter is 90. The default value is 1 day.
 

Tip:  Use this check box to ensure contacts receive only one email every “x”
number of days. For instance, if you want your contacts to receive only one
email per week, you can select this check box and then set the eld to seven.

Honor external suppression list
 

Select this check box to exclude contacts in the external suppression list from receiving
the survey. Clear this check box to send the survey to all contacts in the audience, even
if they are in the external suppression list. See Overview of the External Suppression List
for complete details and procedures about the external suppression list.
 

Limit delivery to a randomly
selected subset of the audience
 

Select this check box to send the survey to a random subset of the audience. Enter a
percentage or use the up and down arrows to select a percentage of the audience to
send the survey to.
 

Allow delivery of messages to
multiple contacts sharing the same
email address
 

Select this check box to send messages to multiple contacts sharing the same email
address. If this check box is cleared, the message is sent only to the contact most
recently updated. This option is available only when email address sharing is enabled.
See Email Address Sharing.
 

CAUTION:  Because duplicate messages sent to a single address are a
common characteristic of spam, you should select this check box only when
necessary. When the check box is selected and you aempt to schedule
or send a mailing, survey, or proof, and duplicate email addresses exist in
your audience, a message warns you that your reputation as a bulk email
sender may be adversely aected and impact your ability to send future
communications.

Exclude from audience if previously
sent
 

Select this check box to exclude contacts from the audience that were previously sent an
invitation from the same survey.
 
This option applies only to recurring surveys. Contacts excluded in this manner are
also excluded from the audience count. See Add or Edit a Recurring Broadcast Survey
Schedule.
 

9. To count the number of contacts who will receive the survey, click Refresh in the Current Count section.
After the audience has been counted, the last count also displays in this section.

10. To view the details of an audience count, click Details in the Current Count section after the count has been
performed.
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View Audience Count Details in Surveys  
You can view the audience count to see how the count is calculated. You can see the included and excluded lists and
segments, along with the number of invalid, opt-out and duplicate emails as well as emails that are part of the external
or global suppression list.

You must count your audience before you can view audience count details.
1. Do one of the following:

◦ From the Summary tab, click Details next to Audience Count.

◦ From the Audience tab, click Details next to Current Count.

The Audience Count Details window opens.

Column Description

Name
 

Lists the name of each segment or contact list included in or excluded from the survey.
 

Type
 

Lists whether the audience subset is a contact list or segment.
 

Gross Size
 

Lists the number of contacts belonging to the list or segment.
 

Overlap
 

Lists the number of contacts belonging to the list or segment who also belong to
another list or segment in the audience.
 

Invalid Email
 

Lists the number of contacts belonging to the list or segment who have an invalid email
address.
 

No Email
 

Lists the number of contacts belonging to the list or segment who do not have an email
address.
 

Duplicate Email
 

Lists the number of email addresses shared by multiple contacts. If the check box is
selected on the Audience tab, allowing delivery to multiple contacts sharing the same
email address, this count is included in the net size count of the audience. If the check
box is not selected, it is subtracted from the gross size when calculating the net size of
the audience.
 
This option is available only when email address sharing is enabled. See Email Address
Sharing.
 

Suppression
 

Lists the number of email addresses that are excluded from the survey because they are
part of the external or global suppression list.

Opt-out
 

Lists the number of contacts belonging to the list or segment who have opted out of
surveys.
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Column Description

Frequency
 

Lists the number of contacts belonging to the list or segment who are ltered by the
survey frequency seings.
 

Recency
 

Lists the number of contacts belonging to the list or segment who are ltered by the
survey recency seings.
 

Net Size of Audience
 

Lists the number of contacts in each list or segment who are included in or excluded
from the survey.
 

Total Audience Size
 

Lists the net total number of contacts who receive the survey.
 

Note:  Audiences are ltered from invitation emails in the following order.

◦ Excluded segments and contacts

◦ Contacts without an email address

◦ Contacts with an invalid email address

◦ Contacts who have opted out

◦ Shared email addresses and duplicate contacts (overlaps in included lists or segments)

◦ Contacts in the global suppression list

◦ Contacts in the external suppression list

◦ Contacts ltered by recency seings

◦ Contacts ltered by frequency seings

Create an Invitation Message in Broadcast Surveys  
The invitation message is what your customers receive in the email inviting them to participate in the survey.

From the Invitation Message tab, you can activate market testing, specify the mailbox seings for the message, the
subject of the email, and any URL parameters you want to aach to the survey link in the message. In addition, you can
create either plain text or HTML messages from scratch, from existing content, or by uploading HTML from another
site.

Note:  By default, a canceled survey can no longer be modied or sent. This ensures that you can accurately
track the content you send your customers. You can, however, copy a canceled survey and then modify and
send the copied survey. See Cancel a Broadcast Survey Invitation Message. Alternatively, you can enable the
RNM_MOD_SENT_DOCS conguration seing (Outreach and Feedback/General/Miscellaneous) to allow
edits to documents that have been used in sent messages. Just be aware when you enable this seing, you
will no longer be able to view the original content sent to your customers, and your reporting will not be as
accurate.

1. From an open survey, click the Invitation Message tab.
2. To activate market testing, click the information bar (above the From address eld) and select Change Market

Testing Mode. See Activate Market Testing in Broadcast Surveys.
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3. To change the mailbox sending the message or the From and Reply-To addresses, click Edit next to the From
address. See Customize the Survey Invitation Message Header.

4. Enter the subject of the message in the Subject eld.
For the best practice on creating eective subject lines, see Ensuring that contacts read your message.

5. To add a merge eld to the subject, click the Merge Field icon (to the right of the Subject eld) and select the
eld. See Insert a Text Merge Field.

6. To create an HTML invitation message from scratch, click Begin with Blank Content and see How the HTML
Editor Works.

7. To create an HTML invitation message by copying an existing document, click Choose Existing Content and
see Insert Existing Content.

8. To create an HTML invitation message by uploading your own HTML page, click Upload HTML Content and
see Upload HTML Content.

9. To create a text version of the invitation message, click the Text tab.
10. To create a text invitation message from scratch, click Begin with Blank Content and see How You Create and

Edit Text-Only Messages.
11. To create a text invitation message by copying an existing document, click Choose Existing Content.
12. To create a text invitation message by converting an HTML page to text, click Convert HTML Content and see

Convert HTML Content.
The system automatically creates a document containing the content created on the Invitation Message tab
and stores it in the Automatically Generated folder in the Documents explorer. When you update the document
in the survey, those changes are also made to the automatically generated copy. In addition, if you make any
changes to the copy in the Automatically Generated folder, those changes are also made to the text on the
Invitation Message tab in the survey. See Automatically Generated Folders.

13. To add URL parameters, enter any parameters you want to append to the links in your message (for example,
p1=v1&p2=v2) in the URL Parameters eld.

14. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld
and select the eld. See Insert a Merge Field to a URL Parameter.

Customize the Survey Invitation Message Header  
If you want to use a dierent name and email address for your survey invitation message, such as a branded email
address, you can do so by customizing the message header.

By default, Oracle RightNow Feedback Cloud Service (Feedback) uses the name and email addresses specied in the
outgoing email seings of your default Outreach mailbox. By customizing the message header, when a recipient views
your invitation message, the name and email addresses dened in the customized header are used instead of those
specied in the default Outreach mailbox.

Note:  Be sure to regularly monitor mail received by the email addresses specied in your custom message
header. If you want replies to your survey invitations to be converted to incidents, your mail administrator
must congure SMTP forwarding from that mail account to an account congured in Oracle Service Cloud. See
How Mailboxes Work.

Also note that when an email message cannot be delivered, it usually results in a “bounce” error notication. Bounce
notications are sent to the Envelope From/Bounce Address dened in the outgoing email seings of your Outreach
mailbox even if the message header is customized using the following procedure. See Email Bounce Handling.

See also Best Practices for Using Branded Email Domains.

1. From the Invitation Message tab of an open survey, click Edit next to the From eld.
The Customize From and Reply-To Headers window opens.

2. Enter eld information.
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Field Description

Mailbox
 

Click this drop-down menu and select a mailbox to change the mailbox from the default.
See Overview of Email Management for complete details and procedures about email
handling.
 

From
 

Enter the name and email address that you want the message to appear from in the
From text boxes.
 

Name
 

Enter the name you want the message to appear from.
 

*Email Address
 

Enter the email address you want the message to appear from.
 

Reply-To
 

Enter the name and email address that you want the message to reply to in the Reply-To
text boxes.
 

Name
 

Enter the name you want to appear as the reply-to address.
 

*Email Address
 

Enter the email address you want to appear as the reply-to address.
 

Note:  If you use incidents, the Reply-To Address must match the Envelope
From/Bounce Address unless your own mail administrator has set up SMTP
forwarding for this address to automatically forward to the Envelope From/
Bounce Address in the outgoing emails seings of your mailbox. See Edit
Common Outgoing Email Conguration Seings and  Answer ID 1272  on our
support site.

Merge Field
 

Click this icon to add merge elds to the from name and address or reply-to name and
address.
 

Preview
 

This section displays how the from and reply-to addresses appear.
 

3. Click OK.

Insert Existing Content  
As an alternative to creating a message from scratch, you can base your message on existing content. You can choose
to copy content into your message and customize it, or share the content with other surveys and messages that use the
document.

1. From the Message tab of a mailing or the Invitation Message tab of a survey, click Choose Existing Content.
The Choose Document window opens.
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2. Select the document you want to use and click OK. If it is not already in use by another mailing, campaign, or
survey, the content is added to your message. Otherwise, the Content Already in Use window opens.

a. To share the document with the items indicated in the grid, click Share Content.
When you share a document, you can edit the content of the document, but all other messages that
share it are also modied. Likewise, if another sta member edits the document, your message is also
modied.

b. To create a copy of the document, click Copy Content.
If you edit the copied content, the original document is not aected. Conversely, if the content of the
original document is modied, it does not aect your copy of the message.

CAUTION:  The system automatically creates a document containing the copied content and stores it
in the Automatically Generated folder in the Documents explorer. When you update the document in
the mailing or survey, those changes are also made to the automatically generated copy. In addition, if
you make any changes to the copy in the Automatically Generated folder, those changes are also made
to the content of the mailing or survey. See Automatically Generated Folders.

Upload HTML Content  
You can upload an HTML le into your document, template, snippet, mailing or survey to create your message. The
HTML document must be stored in a le accessible through your workstation. You cannot access the HTML of a web
page.

1. From the HTML tab of a document, the Message tab of a mailing, the Invitation Message tab of a survey, or
from a new template or snippet, click Upload HTML Content.

2. Select the HTML le you want to upload.
3. Click Open.

The HTML is inserted in your message.

Convert HTML Content  
When creating a text message, you can take HTML content from the HTML message or from an HTML le and convert
it to plain text.

You should nalize your HTML content before converting it to text.
1. From the Message tab of an open mailing or the Invitation Message tab of an open survey, click the Text tab

and then click Convert HTML Content.
The HTML to Text window opens.

2. To convert the HTML message to text, select HTML Part.

3. To convert an HTML le to text, select the File On Disk and browse for the le.
4. Click OK.

The converted HTML is added to the text part of your message.

Activate Market Testing in Broadcast Surveys  
When creating a broadcast survey, you can test dierent content and designs on a subset of your audience by using
market testing.

For broadcast surveys, market testing is available in two modes: even split and random sampling.

• Even split—This mode sends your test message to equal portions of your audience. For example, if you created
four messages, each message would be sent to twenty-ve percent of your audience. In this way, you can test
dierent content and designs for use in future messages.
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• Random sampling—This mode sends test messages to a percentage of the audience you specify. After the test
messages are sent, you send a nal message to remaining audience members. For example, you could send
two messages to ve percent of your audience each. After determining the most eective message, you would
send a nal message to any audience members who had not received a test message.

By default, the Invitation Message tab is set up without market testing. This means you create and send only one
invitation message.

1. On the Invitation Message tab of an open survey, click the information bar (above the From address eld) and
select Change Market Testing Mode.
You can also access this window on the Summary tab by clicking Change next to Market Testing.
The Select Market Testing Mode window opens.

2. To send test messages to equal portions of your audience, select Even Split. See Create Messages in Even Split
Mode.

3. To send test messages to a percentage of your audience, select Random Sampling. See Create Messages in
Random Sampling Mode.

4. To disable market testing, select None.

Note:  If you have created more than one test messages, the Select Message To Keep window opens
asking you which message you want to use. You must select a message to keep before you can disable
market testing.

5. Click OK.

Create Messages in Even Split Mode  
When creating messages in even split mode, you dene dierent message content and proong options for each
version of your message. Your audience is split evenly between the messages. The messages are sent at the same time
and share delivery options.

1. From the Select Market Testing Mode window, select Even Split and click OK.
The Message tab (mailings) or the Invitation Message tab (surveys) displays in even split mode.

By default, one test message is sent to 100 percent of the audience. From here, you can add more messages,
edit messages, send proofs, or view results. From here, you can also see information about each message.

Column Description

Name
 

This column displays the name of the message.
 

Subject
 

This column displays the email subject line for the message.
 

Audience
 

This column displays the percentage of the audience the message will be sent to.
 

Sent
 

This column displays the number of emails sent with the message.
 

Delivered
 

This column displays the number of emails sent with the message that did not bounce.
 

Opened This column displays the number of unique email recipients who opened the message.
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Column Description

   

Clicked
 

This column displays the number of unique email recipients who clicked a tracked link.
 

Unsubscribed
 

This column displays the number of email recipients who unsubscribed from mailings.
 
Unsubscribe sets global opt-in in both Outreach and Feedback. See Insert an
Unsubscribe Link.
 

Replied
 

This column displays the number of times the mailing was replied to.
 

2. Click New on the toolbar to add a second test message.
The Edit Message window opens.

3. Enter the name of the message in the Name eld.
4. Enter the subject of the message in the Subject eld on the Content tab. See Create a Message in Broadcast

Mailings and Create an Invitation Message in Broadcast Surveys.
5. Dene any other content or formaing options you may want to test using either the HTML editor or the text

editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-Only Messages.
6. To send a proof message, click the Proong tab on the Edit Message window. See Send a Proof.
7. Click OK to save the message.

The new message is added to the Message tab (mailings) or the Invitation Message tab (surveys).
8. To open a message for editing, select the message and click Open.
9. To delete a message, select the message and click Delete.

10. To copy a message to create another test message, select the message and click Copy.

Note:  A document is automatically created and stored in the Automatically Generated folder in the
Documents explorer for every copy of a test message. Changes made to content in any of the copied
test messages is not shared with the original test message or subsequent copies. See Automatically
Generated Folders.

11. To send a proof of a message, select the message and click Send Proof.
12. To preview the content of a message, select the message and click Preview.
13. To refresh the message statistics, click Refresh.
14. To add URL parameters, enter any parameters you want to append to the links in your message (for example,

p1=v1&p2=v2) in the URL Parameters eld.
15. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld

and select the eld. See Insert a Merge Field to a URL Parameter.

Create Messages in Random Sampling Mode  
You should use random sampling mode when you want to send a sample of test messages to your audience before
determining the best one to use as a nal message.

When creating messages in random sampling mode, you dene dierent message content, designs, delivery, and
proong options for each version of your message. After you evaluate the eectiveness of your test messages, you
create a nal message and send it.

For the best practice on how to handle scheduling, see Scheduling Mailings and Surveys for Market Testing.

1. From the Select Market Testing Mode window, select Random Sampling and click OK.
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The Message tab (mailings) or Invitation Message tab (surveys) displays in random sampling mode.

By default, one test message is sent to ve percent of the audience, and one nal message sent to the
remainder of the audience. You can add more messages, edit the messages, send proofs, or view results. From
here, you can also see information about each message.

Column Description

Name
 

This column displays the name of the message.
 

Subject
 

This column displays the email subject line for the message.
 

Status
 

This column displays the status of the message. See Mailing Delivery Statuses and
Survey Delivery Statuses.
 

Audience
 

This column displays the percentage of the audience the message will be sent to.
 

Sent
 

This column displays the number of emails sent with the message.
 

Delivered
 

This column displays the number of emails sent with the message that did not bounce.
 

Opened
 

This column displays the number of unique email recipients who opened the message.
 

Clicked
 

This column displays the number of unique email recipients who clicked a tracked link.
 

Unsubscribed
 

This column displays the number of email recipients who unsubscribed from mailings.
 
Unsubscribe sets global opt-in in both Outreach and Feedback. See Insert an
Unsubscribe Link.
 

Replied
 

This column displays the number of times the mailing was replied to.
 

2. Click New on the toolbar to add a second message.
The Edit Message window opens.

3. Enter the name of the message in the Name eld.
4. Enter the number or percentage of recipients you want to receive the message in the Test Audience eld and

select Percent or Recipients from the drop-down menu.
The percentage of recipients is based on the number of contacts in the audience at the time the mailing is sent.

5. Enter the subject of the message in the Subject eld on the Content tab. See Create a Message in Broadcast
Mailings.

6. Dene any other content or formaing options you may want to test using either the HTML editor or the Text
editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-Only Messages.
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7. To send a proof message, click the Proong tab on the Edit Message window. See Send a Proof.
8. Click the Delivery tab on the Edit Message window to dene the delivery options for the message. See Access

Broadcast Mailing Delivery Options or Access Broadcast Survey Delivery Options.

Tip:  When sending multiple test cells, we recommend scheduling them to be sent all at one time
rather than a few minutes apart. This minimizes any performance impact on your database by sharing
audience segmentation processes across all of the sending cells, instead of performing them multiple
times.

9. Click OK to save the test message.
The new message is added to the Message (mailings) or the Invitation Message (surveys) tab.

10. To open a message for editing, select the message and click Open.
11. To delete a message, select the message and click Delete.

Note:  You cannot delete the nal message.

12. To copy a message to create a new message, select the message and click Copy.
A document is automatically created and stored in the Automatically Generated folder in the Documents
explorer for every copy of a test message. Changes made to content in any of the copied test messages is not
shared with the original test message or subsequent copies. See Automatically Generated Folders.

13. To send a proof of a message, select the message and click Send Proof.
14. To preview the content of a message, select the message and click Preview.
15. To refresh the message statistics, click Refresh.
16. To add URL parameters, enter any parameters you want to append to the links in your message (for example,

p1=v1&p2=v2) in the URL Parameters eld.
17. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld

and select the eld. See Insert a Merge Field to a URL Parameter.
18. When you are satised with your message, you must copy it as your nal message and then dene delivery

options.
a. Select the message and click Copy To Final.

The message you selected is copied to the Final Message section of the Message tab (mailings) or the
Invitation Message (surveys) tab.

b. Click OK.
c. Select the nal message and click Open.

The Edit Message window opens.
d. Click the Delivery tab on the Edit Message window to dene delivery options.

Send a Proof  
An important step in creating a mailing or a survey is ensuring the content is approved by the necessary contacts and
sta members and as a nal check for any mistakes.

You can send a proof to any combination of sta accounts, sta groups, proof lists, distribution lists, and distribution list
available addresses, and then view the results of the proof from the Proong tab. See Add or Edit a Distribution List.

After a reviewer has approved or rejected the proof, the assigned sta member will receive a Mailing Proof Response
Notication or a Survey Proof Response Notication. Both notications can be customized using message templates
found in the Administrator Notications message type under the Outreach or Feedback category respectively. See How
You Customize Messages.
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Proof surveys and mailings are subject to the following behaviors and limitations.

• If your message contains conditional sections, all conditional sections display in the proof message. However,
reviewers see the conditional sections only if they can be mapped to contact records that allow access to those
conditional sections.

• If a form on the proof contains an email address eld and a reviewer submits a value for the eld in the survey
preview, a contact record is created or updated so that advanced survey functions can be tested. For this
reason, be sure that your reviewers use only test contact addresses to avoid updating production contacts
when testing survey proofs.

• To ensure the proong process does not impact statistics after the mailing or survey has been sent, Outreach
and Feedback does not retain data submied from proof surveys. If you want to submit test responses without
impacting specic statistics, you can copy the mailing or survey and test using the copy instead.

For the best practice about sending proofs, see Send Proofs to Key Sta.

1. From an open mailing or survey, click the Proong tab.
2. Click Send Proof Message to select proof recipients.

The Send Proof Message window opens.

Tip:  From the Summary tab, clicking Send Proof Message opens the Send Proof Wizard where you
can select the survey you want to send for a proof, and then follow the wizard as it steps you through
the process of sending your message.

3. To create a proof list, click New Proof List and see Add a Contact List.
4. Enter an email address or the name of a group or proof list in the Recipients eld.
5. To select proof recipients from a list, click the Select Recipients icon (to the right of the Recipients eld). The

Select Names window opens.
a. Select a sta member, address, group, or proof list and click To.
b. To nd a specic sta member, address, group, or proof list, enter the name in the Type Name or Select

From List eld.
The rst item matching the leers you type is selected in the grid.

c. To import your contacts from the default Contacts folder in Outlook, select Load Outlook Contacts. This
is useful for displaying contacts that are not included in Oracle Service Cloud. See How You Synchronize
Contacts.

d. Click OK.
6. Enter any comments you want to appear in the message in the Comment text box.
7. To spell check your comments, click the Spell Check icon (to the right of the Comment eld).
8. To customize your proof message by contact record, which lets your reviewers see how dynamic content will

look for a specic contact, click the Search icon next to the Preview Contact eld on the boom of the window.
The Contact Search window opens.

a. Enter your search criteria in one or more of the available elds and click Search.
A list of contacts that match your search criteria displays in the grid below the search criteria elds.

b. Select a contact and click Select.
The Contact Search window closes and the contact name you selected populates the Preview Contact
eld on the Send Message Proof window.

9. Click Send Proof Message.

Accept or Reject a Proof Email  
After you send a proof, the recipients can accept or reject the mailing or survey content.
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The proof email automatically displays a link to a web page where the tester can accept or reject the content. The word
“Proof:” is prepended to the message subject. The assigned sta member receives either a Mailing Proof Response
Notication or a Survey Proof Response Notication every time a reviewer submits feedback.

1. In a proof email, click the Submit Your Feedback link.
A new window opens where you can make comments and accept or reject the proof.

2. Enter any comments related to the proof mailing or survey in the Comments for Mailing Organizer text box.
3. Do one of the following:

◦ To approve the mailing, click Approve.

◦ To reject the mailing, click Reject.

A message displays conrming your submission.

Proof Results  
After you have sent the proof message, you can easily check the proof results from the Proong tab.

The Proong Results section lists all message proofs that were previously sent for the selected mailing or survey,
grouped by date and time. You can see how many times the proof was viewed, who accepted and rejected the proof,
and any comments from the proof testers.

Column Description

Recipient
 

This column displays all recipients of the proof mailing or survey.
 

Views
 

This column displays the number of times each recipient views the message.
 

Media
 

This column displays whether the recipient received HTML or text content.
 

Approved
 

This column displays whether each recipient approved the proof (Yes or No). The column is blank if the
recipient has yet to approve or reject the proof.
 

Comments
 

This column displays the recipient’s comments.
 

Access Broadcast Survey Delivery Options  
The Delivery tab lets you choose to send the survey immediately or schedule its delivery for sometime in the future. In
addition, you can control the speed of the delivery and access common administration tasks for the survey.

You must create a questionnaire before delivering the survey. See Create a Questionnaire in Basic Mode.

After you have created the questionnaire, dened the audience, created an invitation message, and sent proofs of the
survey, you can send the survey to your customers.

1. From an open survey, click the Delivery tab.
The Delivery tab is divided into sections. The Delivery Status section displays the status of the survey (see
Survey Delivery Statuses) and contains buons for controlling the sending of the survey. You can perform the
following tasks from this section.

◦ Send a survey—See Send a Broadcast Survey.

◦ Schedule a survey, Unschedule a survey, and Reschedule a survey—See Schedule a Broadcast Survey.

◦ Set a recurring survey—See Add or Edit a Recurring Broadcast Survey Schedule.
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◦ Suspend a survey—See Suspend a Broadcast Survey.

◦ Cancel a survey—See Cancel a Broadcast Survey Invitation Message.

The Delivery Options section lets you set options related to sending the survey.

On the boom of the tab, delivery information about the survey is available for you to quickly scan and assess
in the Delivery Checklist and Message Send History sections.

Section Description

Delivery Checklist
 

This section displays the audience count and proof history and provides a link to
preview the survey.
 

Audience Count
 

After an audience count has been performed, this section displays the most recent
count and the time and date it was performed. Click Refresh to perform an updated
audience count. See Dene the Broadcast Survey Audience.
 

Message Preview
 

This section contains a link to preview the message that is sent with the survey. Click
Preview to preview the message.
 

Proong
 

This section displays a summary report of message proofs associated with the survey.
Click Send Proof Message to send the message as a proof.
 

CAN-SPAM Compliance
 

This section contains a link to test survey compliance with the CAN-SPAM Act of 2003.
If you have already tested CAN-SPAM compliance, the test results and a link to the
details of the test display. See CAN-SPAM Compliance.
 

Message Send History
 

This section displays a log of events relating to the delivery status of the survey. If the
survey has not been sent, it is noted here.
 

Send a Broadcast Survey  
Broadcast surveys can be sent immediately from the Delivery tab. The status changes to Preparing to Send and then the
survey is sent to your dened audience. After the survey nishes sending, it is marked Completed.

1. From the Delivery tab of an open survey, enter eld information in the Delivery Options section.

Field Description

Limit delivery rate to no more than x
messages per hour
 

Select this check box to control the rate of delivery and then click the drop-down menu
to select the number of emails to send per hour.
 

CC proof audience on send
 

Select this check box to copy the sent survey to your proof message recipients. The
phrase “Proof Copy:” is prepended to the message subject.
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Field Description

Proof members may receive two messages if they are also part of the audience.
 

2. Click Send Now.
A window opens asking you to conrm that you want to send the survey.

3. Click Yes to send the survey.
The delivery status on the Delivery tab changes to Preparing to Send and you can see the delivery progress of
the survey.

When the survey is nished sending, the status changes to Completed and the Delivery Status section displays the
number of emails sent and delivered.

Schedule a Broadcast Survey  
You can schedule broadcast surveys to be sent on a specied date and time. This lets you coordinate sending a survey
before the actual send date. For example, to send a survey that coincides with a product launch. When scheduled, the
survey automatically sends.

1. From the Delivery tab of an open survey, enter eld information in the Delivery Options section. See Send a
Broadcast Survey for eld descriptions.

2. Click Schedule.
The Conrm Schedule Invitation Message window opens.

3. Enter the date and time you want to send the survey or click the calendar (to the right of the Time to Send
Invitation Message eld) and select the date.

4. Click OK.
The Delivery Status section displays the time and date the survey is scheduled to send.

5. To unschedule a survey without canceling it, click Unschedule.
This way, the survey can be scheduled later.

6. To reschedule the survey, click Reschedule.
7. To cancel a survey schedule, click Cancel Invitation Message.

a. Click OK to conrm you want to cancel the invitation message.

Tip:  To edit or send a survey that has been canceled, rst copy the survey and then edit or send the
survey copy. See Cancel a Broadcast Survey Invitation Message.

Add or Edit a Recurring Broadcast Survey Schedule  
Survey recurrence lets you send broadcast survey invitations at regular daily, weekly, monthly, or yearly intervals with a
number of exible options.

• You can schedule invitations to send during a specic date range, or set no end date to allow recurrences to run
indenitely.

• You can schedule invitations to send on specic days of the month or specic months of the year.

• You can send an invitation to each contact in your audience only once or include all matching contacts every
time the recurrence is initiated.

• You can select the time of day that you want invitations to begin sending.

Information about past recurrences—such as the time last run, next scheduled runtime, the time the schedule was last
updated, and basic results data—is stored in the knowledge base and tracked in the Recurring Surveys Summary report
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(Public Reports/Feedback/Survey Performance). Also, each recurrence is tracked in the survey audit log along with a
description of how many invitations were sent. See Audit Logs.

Before you set a recurring schedule, you must rst dene the audience and the invitation message subject and content.
After recurrence has been set, you can click Suspend to suspend recurrences. This saves the recurrence information so
it can be edited or reactivated.

1. From an open survey, click the Delivery tab.
2. Click Recurrence.

The Conrm Schedule Recurrence window opens.
3. Enter eld information.

Field Description

Recurrence Paern
 

Select the weekly or monthly interval when the survey should be sent. For example, a
survey could be sent every two weeks on Tuesday, or every month on the 7th and 19th.
 

Clear All
 

Click this text to clear all selected recurrence paern check boxes.
 

Monthly
 

Select this option to display check boxes for the days of the month. You can then select
the days of the month when the survey should be sent.
 

Weekly
 

Select this option to display check boxes for each day of the week. You can then select
the check boxes next to the days when you want the survey to be sent.
 
When you select this option, a Recur drop-down menu displays where you can specify
the frequency of the weekly survey. For example, if you want to send a survey every
week on the days selected, enter 1 in the eld. If you want the survey to send every third
week on the days selected, enter 3 in the eld. This eld accepts values from 1 to 99.
 

Schedule Specic Months
 

Click this header to display check boxes for the months of the year. Select the months
during which the survey should send. By default, every month is selected, but if you do
not want to send during a specic month, you can clear the check box for that month.
 

Clear All
 

Click this text to clear all check boxes for the selected months.
 

Range of Recurrence
 

Options in this section let you specify a date range for the recurrence and time of day at
which the survey is sent.
 

Start
 

End
 

Enter the start and end dates of the schedule or click the calendars to select the dates.
The current day is the default start date.
 

Time to send survey Enter the time of day to begin sending the survey.
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Field Description

   

4. Click OK to save the recurrence seings and return to the Delivery tab.
5. To suspend the recurrence, click Suspend. The Conrm Suspend window opens.

a. Click OK to conrm you want to suspend the recurrence.

Note:  After recurrence is suspended, you can click Recurrence again to edit or reactivate it.

6. To exclude contacts from the audience that were included in a previous instance of the recurrence, click the
Audience tab and select Exclude From Audience if Previously Sent.

Tip:  By default, a recurring survey sends on every recurrence to every contact that matches your
audience, even contacts who previously received an instance of the same message. If you want
each contact to receive only one instance of a recurring survey, you must exclude contacts from
the audience that were previously sent to. This is often helpful when sending a one-time oer. For
instance, sending a one-time oer to all contacts who have a birthday in the next month.

Suspend a Broadcast Survey  
You may want to stop sending a survey while it is sending or preparing to send. You can temporarily stop a survey from
sending by suspending it.

1. From the Delivery tab of an open survey, click Suspend.

Note:  This buon appears only when a survey is in the process of sending.

The Conrm Suspend message opens asking you to conrm that you want to suspend the survey.
2. Click Yes to conrm suspending the survey.

The status changes to Suspended and the Delivery Status section displays the number of audience members the survey
was already sent and delivered to.

Cancel a Broadcast Survey Invitation Message  
You can cancel a survey invitation message at any time. When you cancel the survey invitation message, the survey is
saved and you can still view survey results. However, the invitation message cannot be sent or further modied.

By default, a canceled survey can no longer be modied or sent. This ensures that you can accurately track the content
you send your customers. You can, however, copy a canceled survey and then modify and send the copied survey.

Tip:  Alternatively, you can enable the RNM_MOD_SENT_DOCS conguration seing (Outreach and
Feedback/General/Miscellaneous) to allow edits to documents that have been used in sent messages. Just
be aware when you enable this seing, you will no longer be able to view the original content sent to your
customers, and your reporting will not be as accurate.

1. From the Delivery tab of an open survey, click Cancel Invitation Message.
The Conrm Cancel Invitation Message window opens asking you to conrm that you want to cancel the
invitation message.

2. Click Yes to cancel the survey.

The delivery status changes to Canceled.
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View Survey Results  
In addition to helping you create and send eective surveys, Feedback provides a comprehensive set of reports and
monitoring tools to help you process and analyze the results.

The Results tab displays a list of standard reports that present survey response data as well as information about
the eectiveness of your survey invitation messages, such as total emails sent and delivered, survey link clicks,
unsubscribes, bounces, and forwards. You can also track question response rates, survey reminder statistics, mobile
survey trends, and trending information based on timeline. Other reports can be added to the list to provide more
analytical options for your survey.

Note:  The email gateway must be activated in order for the Techmail utility to capture bounce data for
analytics. See Email Bounce Handling.

Feedback also features topic monitoring for text responses in the survey. Topic monitoring helps you analyze text
responses by grouping them into topics and identifying them by common keywords. See Topic Monitoring.

1. From an open survey, click the Results tab.
The list of standard reports display.

2. Select a report from the Results Reports list.

Tip:  When you select a report, the report description displays in the area below the list to help you
understand the purpose of the report.

3. Click Go.
The report displays on a new tab.

4. To view a denition of the report, including its tables, lters, and column descriptions, click Denition on the
ribbon and select View.

5. To view the same report for a dierent survey, select the survey from the Survey Name drop-down menu and
click Search.

Customize the Survey Report List  
The survey reports list provides a set of useful standard reports that display results information about the survey you
are editing. However, you can add or remove reports to customize the list.

1. From the Results tab of an open survey, click Customize List.
The Customize Survey Report List window opens.

2. To add a report to the survey report list, do one of the following:

◦ Select a report from the Available Items list and click Add.

◦ Press Ctrl while selecting each report you want to add at the same time. You can also press Shift to select
multiple consecutive reports.

3. To search for a report in the Available Items list, click Find In List and enter the name (or part of the name) of
the report you are looking for.

4. To remove a report from the survey report list, select the report in the Selected Items list and click Remove.
5. To rearrange the order of the reports you are adding, select a report in the Selected Items list and click the up or

down arrow.

Tip:  You can also drag and drop reports to adjust their position.

6. Click OK to close the window and update the list.

Added reports display at the boom of the list.
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How You Track Transactional Survey Results by Agent  
Tracking which agent was assigned to the incident (or opportunity) at the time the transactional survey was sent is
important for gauging agent success rates.

The question_sessions.acct_id eld is used to track this information, and is available when reporting on survey results.
The account ID value (acct_id) is added directly to the Question Sessions (question_sessions) table. Because system
processes can ultimately change the agent assignment at any point in its lifecycle, even after a related transactional
survey is sent, this ensures that the agent the survey results are tied to are accurate.

When the survey is sent, the account ID for the related record is encrypted in the URL that is included in the survey
invitation message. When the survey is submied, that account ID value is set in the question_sessions.acct_id eld of
the Question Sessions table. Since the account ID is included in the URL at the time the survey is sent, even if the agent
assigned to the record changes between when the survey is sent and submied, the account ID value submied for the
survey does not change from the send time value.

Note:  This functionality also applies to surveys popped at the end of a chat session. In this case, however,
question_sessions.acct_id is based on the nal agent assigned at the end of the chat session and is set when
the survey is completed.

Related Topics
• Create a Transactional Survey

Exclude or Include a Survey Response  
If you nd a survey response that is invalid—for example, a question appears to have been misunderstood or answered
incorrectly—you can improve the accuracy of your data by excluding the response from your survey results.

When you exclude a survey response, you exclude all answers submied by the contact during the entire
survey response session. Excluded responses are not actually deleted from the system. Instead, the
question_sessions.ac_ignore eld is set to Yes, which excludes the response session from any reports that include this
lter. For this reason, excluding (or including) a survey response aects its visibility across all reports that lter on the
question_sessions.ac_ignore eld.

1. From an open survey results report, select the record from which you want to exclude a response and click
Response Exclusion on the ribbon.
The Response Exclusion buon is enabled only on reports with response data that list results.
The Response Exclusion window opens.

2. To exclude the response from survey results, select Exclude Response.
3. Click OK.
4. To see your change reected on your report, click Refresh.

Note:  When you exclude a survey response you exclude all answers submied by the contact.

5. To include a previously excluded response back into the survey results, click Search on the ribbon.
This feature does not work when cross tabbing is used in the report or if the report displays data from multiple
responses in a single row.

a. Clear the No check box, select the Yes check box, and click Search. By changing your search criteria for
response exclusions, you’ve changed the data that displays on the report.
Now, all records that have responses excluded will display.

b. Click Response Exclusion on the ribbon.
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The Response Exclusion window opens with the Include Response option selected.
c. Click OK.
d. To see the responses added back into your report, click Search on the ribbon and change your Response

Exclusion criteria from Yes to No.
e. Click Search.

All records that are set to “Include Response,” including those that had previously been excluded, now
display.

Topic Monitoring  
Text responses often provide the most valuable information you receive. However, text responses can be more dicult
to analyze than multiple choice questions that can be counted and included in graphs. A useful approach for analyzing
text responses is to group responses containing similar content and look for emerging themes.

Since the process of clustering (grouping responses and identifying themes) can be time consuming and tedious,
Feedback can automatically perform this task, providing an easy method to spot trends in text responses to your survey
questions. Topic monitoring lets you view the distribution of responses across themes and drill down into themes or
sub-themes to read individual responses. Themes are accessed through the survey Results tab and the topic monitoring
report in Analytics.

Cluster Text Responses  
Grouping responses and identifying themes can help you analyze text responses received from customers.

1. In the Topic Monitoring section on the Results tab, click Go.
The Topic Monitoring Wizard opens.

2. Select a question from the Select a Survey Question drop-down menu.
The question text appears below the menu.

Note:  In order to be clustered, the question you select must have received at least ten responses.

3. Select Cluster Responses.
4. To view recent cluster results without re-clustering, select View Previous Results and see the descriptions in

the Topic Monitoring Report table.
5. Click Finish.

The Topic Monitoring Wizard closes and the Clustering Progress section displays on the Results tab.
When clustering is complete, the resulting themes display on the Results tab.

Field Description

Report Fields
 

Topic monitoring results include the following information.
 

Theme Name
 

This column displays the keywords that identify the theme or the name specied for the
theme. Click the theme name to drill down into sub-themes, if they exist.
 

Responses
 

This column displays the number of text responses included in the theme. Click this
number to drill down into the report and view a list of the text answers.
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Field Description

Average SmartSense
 

This column displays the average SmartSense rating for the text responses included in
the theme.
 

Theme Denition
 

Click Details to view the top keywords for the theme and the theme type.
 

Change Results Report
 

Click this text to return to the default Results tab.
 

Tasks
 

Use the options in this section to cluster responses, reset clustering, edit themes, and
open the Topic Monitoring Wizard.
 

Cluster Responses
 

Click this option to recluster the responses using your customized themes.
 

Reset Clustering
 

Click this option to recluster the responses without using your customized themes.
 
Your custom themes are retained. However, they cannot be used during this clustering
session.
 

Edit Themes
 

Click this option to edit the themes used in clustering. See Edit Themes.
 

Clustering Wizard
 

Click this option to open the Topic Monitoring Wizard and cluster responses for a
dierent question.
 

Question Info
 

This section displays the name and Question ID of the selected question.
 

Edit Themes  
If you want to create your own themes based on specic words, you can customize the keywords that determine the
themes used during clustering by editing themes or creating new ones. During the clustering process, the themes you
create are emphasized more than automatically generated themes.

1. In the Topic Monitoring section on the Results tab, do one of the following:

◦ Click Go.

◦ Click Edit Themes in the Survey Tasks section on the Results tab that displays response themes for a
question.

The Topic Monitoring Wizard opens.

Note:  Response themes are only displayed after clustering has nished and there are at least ten
question responses for the survey.

2. Select a question from the Select a Survey Question drop-down menu.
The question text appears below the menu.

3. Select Edit Themes/Keywords and click the Next.
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The Edit Themes page opens in the wizard.

◦ The Edit Themes window is divided into two sections: Themes to Include and Previously Suggested
Themes. The Themes to Include section displays a list of themes that are used in clustering. You can also
add and import themes through this section.

◦ The Previously Suggested Themes section displays a list of themes that were created during the
clustering process. Suggested themes change each time responses are clustered. However, you can
prevent a suggested theme from being automatically modied by moving it to the Themes to Include
section. See Include a Suggested Theme.

4. When you are done editing themes, click Next.
The Final Action page opens.

5. To close the Topic Monitoring Wizard and return to the survey without clustering responses, select Resume
Survey Editing.
If you select the Resume Survey Editing option, changes made to themes are saved, but responses are not
clustered. The next time you cluster responses, your themes are applied.

6. To cluster responses and return to the survey, select Cluster Responses.
7. Click Finish.

Add Custom Themes  
When editing themes, you can customize them to t your unique needs.

1. From the Edit Themes page of the Topic Monitoring Wizard, click Add in the Themes to Include section.
The Theme Editor window opens.

2. Enter a name for the theme in the Name eld.
3. Enter a keyword that you want associated with this theme in the Keyword eld and click Add.

The keyword is added to the Keyword list.

Note:  Multiword keywords are not supported by the topic monitor. If multiple words are entered for
a single keyword value, only the rst word will be used. If the resulting outcome produces too many
matches that are irrelevant to your search, try adding other keywords that relate to an appropriate
subset of your topic. For example, adding the multiword phrase “customer experience” as a keyword
will produce the same eect as adding the single keyword “customer” and the word “experience” will
be ignored. For a more accurate result set, add keywords “customer” and “experience” separately.

4. To edit a keyword, click Edit next to the keyword.
5. To remove a keyword from the list, click Remove next to the keyword.
6. To move a keyword up or down in the list, use the up and down arrows to the right of the keyword list.

When responses are clustered, the keywords at the top of the list are considered more important than the
keywords at the boom of the list.

7. Click OK.

Import Themes  
When editing themes, you can import themes from existing survey questions.

1. From the Edit Themes page of the Topic Monitoring Wizard, click Import in the Themes to Include section.
The Import Themes window opens.

Note:  Only questions that have been clustered or have custom themes display in the tree.

2. Select a question from the tree and click OK.

The imported themes are added to the Themes to Include section.

1610



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

All themes included with the question are imported. You can edit or delete them after the import. Suggested themes are
not imported.

Edit a Theme  
The following procedure describes the steps pertaining to the Theme Editor window.

1. From the Edit Themes page of the Topic Monitoring Wizard, click Edit next to the theme in the Themes to
Include section.
The Theme Editor window opens.

2. To edit a keyword, click Edit next to the keyword.
3. To remove a keyword from the list, click Remove next to the keyword.
4. To move a keyword up or down in the list, use the up and down arrows to the right of the keyword list.

Note:  When responses are clustered, the keywords at the top of the list are considered more
important than the keywords at the boom of the list.

5. Click OK.

Include a Suggested Theme  
The Previously Suggested Themes section displays a list of themes that were created during the clustering process.
Suggested themes change each time responses are clustered. However, you can prevent a suggested theme from being
automatically modied by moving it to the Themes to Include section.

1. To include a suggested theme, do one of the following:

◦ Click Copy next to the suggested theme in the Previously Suggested Themes section. The suggested
theme appears in the Themes to Include section.

◦ Select a theme and click the left arrow between the Themes to Include and Previously Suggested Themes
sections.

2. To view a suggested theme, click View next to the theme in the Previously Suggested Themes section.
The View Theme window opens.

Add Stopwords  
After clustering your text responses, you might nd that commonly used words appear as topics. If you want to remove
words from the clustering process to prevent them from being used as topics, you can add the words to the stopword
list.

You can access the stopword list le (exclude_responses.txt) from the File Manager.

Note:  When adding stopwords to the list, you must specify all forms of the word that you want to exclude. For
example, if you do not want phone or phones used as topics, you must add them both to the list.

1. Click Conguration on the navigation pane.
2. Expand Site Conguration, and then double-click File Manager.

The File Manager opens on the content pane.
3. Select Wordlist Files from the Switch To drop-down menu.

The available wordlist les display.
a. Select the exclude_responses.txt le.

The le opens on the content pane where you can make edits.
4. Enter the words you want to add to your stopword list.

Each word must be typed in upper case and separated by a carriage return.
5. Click Save.

You may need to scroll to the boom of the content pane to access the Save buon.
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Best Practices for Topic Monitoring  
Best practices for topic monitoring varies depending on your goals. However, general practices can be applied in all
situations to help you nd the information you are looking for.

1. Cluster responses—Cluster responses before you add stopwords or customize themes.
2. Review themes—Review the predened themes and sub-themes to determine if they are satisfactory. Look for

common words that you think might be breaking your themes into smaller, less denitive clusters. Also look for
certain words that you think might be useful in creating distinctive, useful themes.

3. Add stopwords—If you determine that there are common words that do not contribute to the creation of
distinctive clusters, add them to the stopword list.

Note:  Stopwords you add are applied to all the responses you cluster.

4. Add custom themes—If you determine that there are certain words that can help create distinctive, useful
themes, add a custom theme containing these keywords.

Tip:  Custom themes are most helpful in creating distinctive clusters when they use synonyms. For
example, a theme containing the word “software” should also contain the words “application” and
“program.” If you nd that a word is often misspelled, you can include the common misspelling as a
keyword.

5. Cluster responses again—Cluster the responses again and, if necessary, repeat the previous steps of reviewing
themes, adding stopwords, and adding custom themes until you are satised with the resulting themes.

Tip:  If you use these steps and get results that are less satisfactory than the predened themes, reset
clustering by clicking Reset Clustering in the Tasks section of the Results tab. Any custom themes you
created are retained, but they are not used in the clustering session.

Create a Transactional Survey  
Transactional surveys let you survey customers when an event occurs. When a transactional survey is triggered, the
system sends your customer an email message that links to a survey on a web page.

You can send the email as part of a campaign or as a part of a contact, opportunity, incident, or chat rule. For example,
when an incident is closed, a rule can send a survey to the primary contact of the incident to nd out how satised the
contact was with your customer service.

Note:  The survey will only be sent to the contact once per incident regardless of how many times the rule is
matched.

• For information about using transactional survey aributes in campaigns, see Edit Transactional Survey
Aributes.

• For information about tracking transactional survey results by agent, see How You Track Transactional Survey
Results by Agent.

1. From the Surveys explorer, click New.
A new survey opens on the content pane.

Tip:  You can also create surveys from an open survey by clicking New. Additionally, if your navigation
set is congured to add surveys from the le menu, click  File > Surveys > Survey .
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2. Click Transactional Survey.
By default, the Summary tab is active. From here, you can review general information about the survey in the At
a Glance section, as well as manage survey notes, tasks, and aachments. As you create the survey, you move
through each tab to complete the survey elements.

3. To assign the survey to another sta member (by default, the survey is assigned to the sta member who
creates it), click the Assigned drop-down menu and select the sta member.

a. To search for a sta member, enter the sta member’s name in the Find eld.
Wildcards are supported when searching sta members. You can search strings that include a space by
entering %+Space+character, which is helpful when searching last names. For example, typing %+Space
+b returns all last names starting with the leer b. There is also an implied wildcard when searching, so
typing b in the Find eld returns all items containing the leer b.

4. To let customers answer the survey anonymously, select Allow Anonymous.
Contact information is not required.

Note:  Selecting Allow Anonymous in your survey does not mean that all responses will be
anonymous. If a survey invitation is sent to a contact or an Oracle Service Cloud cookie is detected on
the contact’s computer, or the survey itself contains an email address eld, Feedback aempts to use
that information to identify the contact.

5. Click the text in the At a Glance section to perform common survey functions.

Field Description

Invitation Method
 

This eld displays the invitation method currently selected for the survey. Click Change
to change the method and see Change the Invitation Method of a Survey.
 

Survey Status
 

This eld displays whether the survey is active or inactive. Customers cannot submit
responses to an inactive survey and receive a warning message when aempting to
access the survey URL. See Deactivate a Survey.
 

Expiration Date
 

This eld displays the survey expiration date and time. By default, no expiration date is
set. See Set an Absolute Expiration Date  and Set a Relative Expiration Date .
 

Expiration Max Responses
 

This eld displays the number of responses a survey can accept. If set, this eld also
displays the number of responses received, as well as the number of surveys that are
still allowed. The maximum number of survey responses you can dene is one million.
See Set Expiration Based on Maximum Number of Responses.
 

Expiration Message
 

Click Edit to customize the survey expiration message. See Customize the Expiration
Message .
 
If you do not dene your own survey expiration message, the system default message is
used.
 

Questionnaire
 

This eld displays how many pages and questions are in the survey. Click Preview
Survey to preview the survey.
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Field Description

Responses
 

This eld displays how many surveys were started and completed by customers.
 

Market Testing
 

This eld displays the market testing mode of the survey. Click Change to change
market testing modes. See Activate Market Testing in Transactional Surveys.
 

Proong
 

This eld displays the number of proofs that have been sent, approved, and rejected.
Click Send Proof Message to send a proof. See Send a Proof.
 

Delivery Status
 

This eld displays the delivery status of the survey and the number of emails sent and
delivered. See Survey Delivery Statuses.
 

Rule Visibility
 

Select which rules the survey can be used in. For example, select the Incidents check
box if you want this survey available in an incident rule. You can select from contact,
 opportunity, incident, and chat rules.
 

6. Click the Questionnaire tab to add questions and HTML content to the survey. See Create a Questionnaire in
Basic Mode and Create a Questionnaire in Advanced Mode.

7. Click the Audience tab to dene an audience for the survey. See Dene the Transactional Survey Audience.
8. Click the Invitation Message tab to create the message sent to the survey audience. See Create an Invitation

Message in Broadcast Surveys.
9. Click the Proong tab to send a proof of the message for internal review before sending it to the entire

audience.
10. Click the Reminders tab to create automatic email messages that will prompt your customers either to start

taking the survey or to nish it if they have already started. See Survey Reminders.
11. Click the Delivery tab to select delivery options. See Access Transactional Delivery Options for Surveys.
12. To view the reports associated with the survey, click the Results tab.
13. To preview the survey as it would be viewed on a standard web device, such as a desktop or a laptop, click

Standard on the ribbon.
The survey preview opens in a web browser.

Note:  If a survey contains an email address eld and you submit a value for the eld in the survey
preview, the form creates or updates contact records so that advanced survey functions can be tested.
For this reason, be sure to use only test contact addresses to avoid updating production contacts
when testing survey previews.Also, be careful not to use the preview survey URL in place of the URL of
your completed survey (described in the following step). Information submied on a preview survey is
discarded and has no eect on the data collected by the live survey. For identication purposes, each
preview survey displays a watermark to ensure it is not confused with a live survey.

14. To preview the survey as it would be viewed from a mobile device, click Mobile on the ribbon.
Mobile preview is a limited, browser-based preview that gives you a general idea of how your survey might look
on a smaller device when you are designing your survey from your desktop. With that in mind, always test your
surveys on applicable mobile devices and browsers before you launch them.

15. To copy the URL of the survey to your clipboard, click Survey URL on the ribbon.
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The Survey URL message opens. A URL is automatically assigned to the survey. This is the URL that your
invitation message links to and your customers visit to complete the survey. From this window, you can view
the URL and it is automatically copied to your workstation clipboard.

a. Click OK when you are nished viewing the URL.
16. Click Save.

Related Topics
• Business Rule Actions

• Mobile Surveys

• Congure the File Menu

• View Survey Results

Dene the Transactional Survey Audience  
Even though your rules and campaigns determine which contacts receive the survey, you still need to dene certain
audience options if you want to exclude specic contacts or congure opt-out and external suppression list seings.
You can also set survey frequency and recency limits to narrow your audience.

See Overview of Audiences for complete details and procedures about using contact lists and segments in surveys and
mailings.

1. In the open survey, click the Audience tab.

Note:  The audience for a transactional survey automatically includes all contacts who trigger the
associated transactional event. For that reason, you can select only who is excluded from the survey,
not who is included in it. You can exclude a total of fty contact lists and segments, each containing a
vast number of contacts.

2. To exclude a list from the audience, click Add Contact List in the Excluded section. The Select Contact List
window opens.

a. To add a contact list, click New Contact List and see Add a Contact List.
b. Select the list you want to exclude from the survey audience and click OK.

The list is added to the Excluded grid. Contacts belonging to the list do not receive the survey.
3. To exclude a segment from the audience, click Add Segment in the Excluded section. The Select Segment

window opens.
a. To add a segment, click New Segment and see Create a Segment.
b. Select the segment you want to exclude from the survey audience and click OK.

The segment is added to the Excluded grid. Contacts belonging to the segment do not receive the survey.
4. To edit a list or segment that is excluded from the survey, click Open next to the list or segment name. See Add

a Contact List and Create a Segment.
5. To remove a list or segment from the Excluded section, click Remove next to the list or segment name.
6. Enter eld information about communication options.

Field Description

Honor global opt-in
 

Select this check box to send the survey to contacts who did not explicitly opt out of
receiving surveys and mailings. Clear this check box to send the survey to all contacts in
the audience, regardless of their opt-in preference.
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Field Description

Limit frequency of communication
 

Select this check box to set a frequency limit and then enter a maximum number of
surveys and mailings and a number of days in which contacts can receive messages
before they are excluded from surveys. When the survey is launched, it is not sent to any
contacts who have received the maximum number of surveys and mailings within the
designated time period. The minimum you can enter is two in the last one day.
 
The minimum you can enter is 2 in the last 1 day. The maximum number of days you can
enter is 90.

Tip:  To ensure contacts receive only 1 email every “x” number of days, use the
Limit recency of communication seing described next.

 

Limit recency of communication
 

Select this check box to set a recency limit. Enter the minimum number of days that
should elapse before contacts receive another email. When the survey is launched,
 it is not sent to any contacts who have received a survey or mailing email in the past
specied number of days.
 
The maximum number of days you can enter is 90. The default value is 1 day.
 

Tip:  Use this check box to ensure contacts receive only one email every “x”
number of days. For instance, if you want your contacts to receive only one
email per week, you can select this check box and then set the eld to seven.

Honor external suppression list
 

Select this check box to exclude contacts in the external suppression list from receiving
the survey. Clear this check box to send the survey to all contacts in the audience, even
if they are in the external suppression list. See Overview of the External Suppression List
for complete details and procedures about the external suppression list.
 

Limit delivery to a randomly
selected subset of the audience
 

Select this check box to send the survey to a random subset of the audience. Enter a
percentage or use the up and down arrows to select a percentage of the audience to
send the survey to.
 

Allow delivery of messages to
multiple contacts sharing the same
email address
 

Select this check box to send messages to multiple contacts sharing the same email
address. If this check box is cleared, the message is sent only to the contact most
recently updated. This option is available only when email address sharing is enabled.
See Email Address Sharing.
 

CAUTION:  Because duplicate messages sent to a single address are a
common characteristic of spam, you should select this check box only when
necessary. When the check box is selected and you aempt to schedule
or send a mailing, survey, or proof, and duplicate email addresses exist in
your audience, a message warns you that your reputation as a bulk email
sender may be adversely aected and impact your ability to send future
communications.
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Field Description

How Invitation Messages Work in Transactional Surveys  
From the Invitation Message tab, you can activate market testing and specify the mailbox seings for the mailing, the
subject of the email, and any URL parameters you want to aach to links in the message.

In addition, you can create either plain text or HTML messages from scratch, from existing content, or by uploading
HTML from another site. Creating an invitation message follows the same procedure as creating an invitation message
in a broadcast survey. See Create an Invitation Message in Broadcast Surveys.

Note:  By default, a transactional survey that has been launched or canceled can no longer be modied or
sent. This ensures that you can accurately track the content you send your customers. You can, however,
suspend a launched survey invitation message, make edits, and then relaunch it. See Suspend a Transactional
Survey. For a canceled survey, you can copy it, and then modify and send the copy. See Cancel a Transactional
Survey Invitation Message. Alternatively, you can enable the RNM_MOD_SENT_DOCS conguration seing
(Outreach and Feedback/General/Miscellaneous) to allow edits to documents that have been used in sent
messages. Just be aware when you enable this seing, you will no longer be able to view the original content
sent to your customers, and your reporting will not be as accurate.

Activate Market Testing in Transactional Surveys  
When creating a transactional survey, you can send a sample of test messages to portions of your audience before
determining the best one to use as a nal message. You can dene dierent message content, designs, delivery, and
proong options for each version of your message.

For transactional surveys, market testing is available in audience sampling mode. If more than one message is created
when market testing is used, then contacts who sent the email through a campaign or rule will receive one of the test
messages. When the survey is launched  through a campaign, market testing rotates between the test messages. After
you evaluate the eectiveness of your test messages, you create a nal message.

1. On the Invitation Message tab of an open survey, click the information bar and select Change Market Testing
Mode.
The Select Market Testing Mode window opens.

2. Select Audience Sampling.
3. Click OK.

The Invitation Message tab displays in audience sampling mode.
You can add additional messages, edit the messages, send proofs, or view results. From here, you can also see
information about each message.

Column Description

Name
 

This column displays the name of the message.
 

Subject
 

This column displays the email subject line for the message.
 

Status This column displays the delivery status of the message.
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Column Description

   

Sent
 

This column displays the number of emails sent with the message.
 

Delivered
 

This column displays the number of emails sent with the message that did not bounce.
 

Opened
 

This column displays the number of unique email recipients who opened the message.
 

Clicked
 

This column displays the number of unique email recipients who clicked a tracked link.
 

Unsubscribed
 

This column displays the number of email recipients who chose to unsubscribe from
future emails.
 

Note:  Unsubscribe sets global opt-in in both Outreach and Feedback. See
Insert an Unsubscribe Link.

Replied
 

This column displays the number of times the survey message was replied to.
 

4. Click New on the toolbar to add a second test message.
The Edit Message window opens.

5. Enter the name of the message in the Name eld.
6. Enter the subject of the message in the Subject eld on the Content tab. See How Invitation Messages Work in

Transactional Surveys.
7. Dene any other content or formaing options you may want to test using either the HTML editor or the Text

editor on the Content tab. See How the HTML Editor Works and How You Create and Edit Text-Only Messages.
8. To send a proof, click the Proong tab on the Edit Message window. See Proof Results.
9. Click the Delivery tab on the Edit Message window to access delivery options for the test message. See Access

Transactional Delivery Options for Surveys.
10. Click OK.

The new message displays on the Invitation Message tab.
11. To open a message for editing, select the message and click Open.
12. To delete a message, select the message and click Delete.
13. To copy a message to create a new message, select the message and click Copy.

A document is automatically created and stored in the Automatically Generated folder in the Documents
explorer for every copy of a test message. Changes made to content in any of the copied test messages are not
shared with the original test message or subsequent copies. See Automatically Generated Folders.

14. To send a proof, select the message and click Send Proof.
15. To preview the content of a message, select the message and click Preview.
16. To refresh the message statistics, click Refresh.
17. To add URL parameters, enter any parameters you want to append to the links in your message (for example,

p1=v1&p2=v2) in the URL Parameters eld.
18. To add a merge eld to the URL parameters, click the Merge Field icon to the right of the URL Parameters eld

and select the eld. See Insert a Merge Field to a URL Parameter.
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Access Transactional Delivery Options for Surveys  
After you have created the questionnaire, dened the audience, created an invitation message, and proofed the survey,
you can launch the survey so you can send it in rules and campaigns.

You must create a questionnaire before delivering the survey. See Create a Questionnaire in Basic Mode.

From the Delivery tab, you can launch, suspend, or cancel surveys as well as access common administration tasks and
see the send history.

1. From an open survey, click the Delivery tab.
The Delivery tab is divided into sections. The Delivery Status section displays the status of the survey (see
Survey Delivery Statuses) and contains buons for controlling the sending of the survey. You can perform the
following tasks from this section.

◦ Launch a survey—See Launch a Transactional Survey.

◦ Suspend a survey—See Suspend a Transactional Survey.

◦ Cancel a survey—See Cancel a Transactional Survey Invitation Message.

On the boom of the tab, delivery information about the survey is available for you to quickly scan and assess.

Section Description

Delivery Checklist
 

This section displays the audience count and proof history and provides a link to
preview the survey.
 

Message Preview
 

This section contains a link to preview the message that is sent with the survey. Click
Preview to preview the invitation message.
 

Proong
 

This section displays a summary report of message proofs associated with the survey.
Click Send Proof Message to send the message as a proof. See Send a Proof.
 

CAN-SPAM Compliance
 

This section contains a link to test survey compliance with the CAN-SPAM Act of 2003.
If you have already tested CAN-SPAM compliance, the test results and a link to the
details of the test display. See Check Compliance from the Delivery Tab.
 

Message Send History This section displays a log of events relating to the delivery status of the survey. If the
survey has not been sent, it is noted here.

Launch a Transactional Survey  
After you launch a survey, the status changes to Launched. From the Launched status, you can suspend the survey
invitation message or cancel it.

Transactional surveys must be launched before they can be used in rules or campaigns.
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Note:  By default, a launched transactional survey can no longer be edited. This ensures that you can
accurately track the content you send your customers. You can, however, suspend the survey invitation
message, make edits, and then re-launch it. See Suspend a Transactional Survey.Alternatively, you can enable
the RNM_MOD_SENT_DOCS conguration seing (Outreach and Feedback/General/Miscellaneous) to
allow edits to documents that have been used in sent messages. Just be aware when you enable this seing,
you will no longer be able to view the original content sent to your customers, and your reporting will not be as
accurate.

1. From the Delivery tab of an open survey, click Launch.
2. Click Yes to conrm the survey launch.

The delivery status on the Delivery tab changes to Launched and you can see how many surveys were sent and
delivered.

Suspend a Transactional Survey  
You may want to stop sending a survey after it has already been launched. You can temporarily stop a survey from
sending by suspending it.

1. From the Delivery tab of an open survey, click Suspend.

Note:  This buon appears only when a survey has been launched.

The Conrm Suspend message appears asking you to conrm that you want to suspend the survey.
2. Click Yes to conrm suspending the survey.

The status changes to Suspended and the Delivery Status section displays the number of audience members the survey
was already sent and delivered to.

Cancel a Transactional Survey Invitation Message  
You can cancel a survey invitation message at any time. When you cancel a survey invitation message, the survey is
saved and you can still view survey results. However, the survey invitation message cannot be launched again.

By default, a canceled survey can no longer be modied or sent. This ensures that you can accurately track the content
you send your customers. You can, however, copy a canceled survey and then modify and send the copied survey.

Tip:  Alternatively, you can enable the RNM_MOD_SENT_DOCS conguration seing (Outreach and
Feedback/General/Miscellaneous) to allow edits to documents that have been used in sent messages. Just
be aware when you enable this seing, you will no longer be able to view the original content sent to your
customers, and your reporting will not be as accurate.

1. From the Delivery tab of an open survey, click Cancel Invitation Message.
The Conrm Cancel Invitation Message window opens asking you to conrm that you want to cancel the
invitation message.

2. Click Yes to cancel the survey.

The delivery status changes to Canceled.

Create a Website Link Survey  
You can create website link surveys when you do not need to email a link to the survey or target a specic set of
contacts. Website link surveys are published as a web page and can be linked to from any source.
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For example, you could create a survey that is linked to from the shopping cart on your website. Because website link
surveys are posted as a web page, you do not need to dene an audience or invitation message, or send or launch the
survey. After you save the survey, it is available on the web and can be linked to from your outside source.

1. From the Surveys explorer, click New.
A new survey opens on the content pane.

Tip:  You can also create surveys from an open survey by clicking New. Additionally, if your navigation
set is congured to add surveys from the le menu, click  File > Surveys > Survey . See Congure the
File Menu.

2. Click Website Link.
By default, the Summary tab is active when creating a website link survey. From here, you can review
general information about the survey in the At a Glance section, as well as manage survey notes, tasks, and
aachments (see Survey Management). As you create the survey, you move through each tab to complete the
survey elements.

3. To assign the survey to another sta member (by default, the survey is assigned to the sta member who
creates it), click the Assigned drop-down menu and select the sta member.

a. To search for a sta member, enter the sta member’s name in the Find eld.
Wildcards are supported when searching sta members. You can search strings that include a space by
entering %+Space+character, which is helpful when searching last names. For example, typing %+Space
+b returns all last names starting with the leer b. There is also an implied wildcard when searching, so
typing b in the Find eld returns all items containing the leer b.

4. To remove the ability of customers to answer the survey anonymously, clear the Allow Anonymous check box.

Note:  Selecting Allow Anonymous in your survey does not mean that all responses are anonymous.
If a survey invitation is sent to a contact or an Oracle Service Cloud cookie is detected on the
contact’s computer, or the survey itself contains an email address eld, Feedback aempts to use that
information to identify the contact.

5. Click the text in the At a Glance section to perform common survey functions.

Field Description

Invitation Method
 

This eld displays the invitation method currently selected for the survey. Click Change
to change the method and see Change the Invitation Method of a Survey.
 

Survey Status
 

This eld displays whether the survey is active or inactive. Customers cannot submit
responses to an inactive survey and receive a warning message when aempting to
access the survey URL. See Deactivate a Survey.
 

Expiration Date
 

This eld displays the survey expiration date and time. By default, no expiration date is
set. See Set an Absolute Expiration Date .
 

Expiration Max Responses
 

This eld displays the number of responses a survey can accept. If set, this eld also
displays the number of responses received, as well as the number of surveys that are
still allowed. The maximum number of survey responses you can dene is one million.
See Set Expiration Based on Maximum Number of Responses.
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Field Description

Expiration Message
 

Click Edit to customize the survey expiration message. See Customize the Expiration
Message .
 
If you do not dene your own survey expiration message, the system default message is
used.
 

Questionnaire
 

This eld displays how many pages and questions are in the survey. Click Preview
Survey to preview the survey.
 

Responses
 

This eld displays how many surveys were started and completed by customers.
 

Proong
 

This eld displays the number of proofs that have been sent, approved, and rejected.
Click Send Proof Message to send a proof. See Send a Proof.
 

Rule Visibility
 

Clear the Chats check box to make this survey unavailable as an action in a chat rule.
 
Rule Visibility only displays if Chat is enabled.
 

6. Click the Questionnaire tab to add questions and HTML content to the survey. See Create a Questionnaire in
Basic Mode.

7. Click the Proong tab to send a proof of the survey for internal review before sending it to the entire audience.

Tip:  The email that is sent from the Proong tab for website link surveys uses the Survey Proof
message template. You can customize this message template from the Message Templates editor. For
complete details and procedures about customizing templates, see Overview of Message Templates.

8. To view the reports associated with the survey, click the Results tab. See View Survey Results.
9. To preview the survey as it would be viewed on a standard web device, such as a desktop or a laptop, click

Standard on the ribbon. The survey preview opens in a web browser.
10. To preview the survey as it would be viewed from a mobile device, click Mobile on the ribbon. See Mobile

Surveys.
Mobile preview is a limited, browser-based preview that gives you a general idea of how your survey might look
on a smaller device when you are designing your survey from your desktop. With that in mind, always test your
surveys on applicable mobile devices and browsers before you launch them.

11. To copy the URL of the survey to your clipboard, click Survey URL on the ribbon.
The Survey URL message opens. The system automatically assigns a URL to the survey. This is the URL that
you link to from outside of Oracle Service Cloud. From this window, you can view the URL and it is automatically
copied to your workstation clipboard.

12. Click Save.
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Polling Surveys  
Polling surveys display as a question on a customer portal page or any page that is external to the customer portal.
Polling surveys oer a unique way to engage your customers by asking them a single question, and then using their
responses to gauge your business activities.

After customers submit their response, they see a poll results chart or a thank-you message, depending on the question
type used in the polling survey. Question types include text, choice, and matrix. Any of these question types can be
used, although the choice question type may be the most useful in a polling survey. It is also the only question type that
presents customers with a results chart.

Customers are presented with only a single question. If you activate more than one question in a polling survey, then
one active question is randomly selected to display to customers for a one-hour time period. Every customer who is
oered the poll during that hour sees the same question. At the end of an hour, a new active question is selected at
random.

Since polling surveys allow anonymous responses, if customers are not logged in, they can still respond to the survey. If
customers are logged in, their responses to the survey question are associated with their contact record.

Because polling surveys are posted to a customer portal page or an external web page, you do not need to dene an
audience or invitation message, or send or launch the polling survey.

Note:  Polling surveys are associated with polling widgets—either a Polling widget or a PollingSyndication
widget. Widget aributes and styling options are dened in the customer portal. See Polling Widgets.

Create a Polling Survey  
Polling surveys display as a question on a customer portal page or any page that is external to the customer portal.

1. From the Surveys explorer, click New.
A new survey opens on the content pane.

Tip:  You can also create surveys from an open survey by clicking New. Additionally, if your navigation
set is congured to add surveys from the le menu, click  File > Surveys > Survey .

2. Click Polling Survey.
The Summary tab for a polling survey displays on the content pane.
By default, the Summary tab is active. From here, you can review general information about the polling survey
in the At a Glance section, as well as manage polling survey notes, tasks, aachments, and audit log. As you
create the polling survey, you move through each tab to complete the polling survey elements.

3. To assign the polling survey to another sta member (by default, the survey is assigned to the sta member
who creates it), click the Assigned drop-down menu and select the sta member. To search for a sta member,
enter the sta member’s name in the Find eld.
Wildcards are supported when searching sta members. You can search strings that include a space by
entering %+Space+character, which is helpful when searching last names. For example, typing %+Space+b
returns all last names starting with the leer b. There is also an implied wildcard when searching, so typing b in
the Find eld returns all items containing the leer b.

4. Click the text in the At a Glance section to perform common polling survey functions.
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Field Description

Invitation Method This eld displays the invitation method currently selected for the survey. Click Change
to change the method.
 
After a polling survey is submied by a customer, you cannot change the method.
 

Survey Status
 

This eld displays whether the polling survey is active or inactive.
 

Expiration Date
 

This eld displays the polling survey expiration date and time. By default, no expiration
date is set.
 

Expiration Max Responses
 

This eld displays the number of responses a survey can accept. If set, this eld also
displays the number of responses received, as well as the number of surveys that are
still allowed. The maximum number of survey responses you can dene is one million.
 
This eld works only on sites using Customer Portal Framework Version 3.0 or later.
 

Expiration Message
 

Click Edit to customize the survey expiration message. If you do not dene your own
survey expiration message, the system default message is used.
 
This eld works only on sites using Customer Portal Framework Version 3.0 or later.
 

Question List
 

This eld displays how many active and inactive questions are in the polling survey. The
system supports a maximum of 100 questions.
 
There must be at least one active question in the polling survey.
 

Responses
 

This eld displays how many polling surveys were oered to and submied by
customers.
 

5. Click the Question List tab to add questions to the polling survey.
You can either add existing questions or create new questions. Keep in mind, if more than one question is
used in a polling survey, one question is randomly selected to display to customers for a one-hour time period.
Every customer who is oered the poll during that hour sees the same question. At the end of an hour, a new
question is selected at random.

Tip:  Since all questions are stored in the same place, questions are shared across the dierent survey
types.

6. Click Add Question.
The Select Question window opens.

7. To add an existing question, double-click the question you want to add.
The question is added to the Active Questions list.

8. To add a new question, click Add Question, and then click New Survey Question.
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a. To create a text question, see Create a Text Question.
b. To create a choice question, see Create a Choice Question.
c. To create a matrix question, see Create a Matrix Question.

Note:  Display options which lets you dene HTML properties for all question types, may be
aected by widget styling aributes dened in the customer portal. (Display options are available
on the ribbon of a new question.)

You can also activate and deactivate questions, open questions for editing, and remove questions from
the questions list. Questions with results cannot be removed, but they can be deactivated.

Tip:  Questions can be edited after they have been created, even if they have been used in a polling
survey. Keep in mind that if you edit a question, those changes appear immediately in any polling
survey that uses the question. For this reason, if you want to preserve the integrity of the data
returned by the original question, we recommend creating a new question rather than editing the
existing question.

9. To dene polling survey options, click Polling Options on the ribbon. The Polling Survey Options window
opens.

a. To dene the polling survey title that displays on the web page, enter it in the Poll Title eld.
b. To let respondents see the polling survey results chart on the web page, select Show Chart.
c. To display the total number of votes on the web page, select Show Total Votes.
d. To display polling survey results to all web page visitors, even if they have not responded to the poll,

select Show View Results Link.
e. To dene what happens after customers submit a polling survey, click Add Action in the End of Survey

Actions section. You can also edit, remove, and reorder actions. End of survey actions are handled the
same way as end of survey options in broadcast and transactional surveys.

Note:  In order for an end of survey action to work from an external page, the customer portal needs
to associate the customer with a contact record. Therefore, the customer must be logged in to the
customer portal site, or you must implement open login or pass-through authentication (PTA)
functionality. See Set End of Survey Options.

10. To spell check the polling survey, click Spelling.
11. To preview the polling survey, click Preview Survey.

The polling survey preview lets you see specic questions and switch between views.

Tip:  Since polling surveys are not accessible through a link, you can’t send a proof of your polling
survey to anyone. So previewing and spell checking your polling survey are important steps in your
process.

12. Click the Results tab to view the reports associated with the polling survey.
a. Select a question and click Go.

The question results display in a web browser.

Tip:  If your polling survey uses a text question, you can use topic monitoring to group the text
responses containing similar content so that you can look for emerging themes. See Topic Monitoring.

13. Click Save.

When you save the polling survey, a survey ID is assigned that must be associated to the polling widget in the customer
portal. See Add the Polling Widget to a Page.
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Related Topics
• Customer Portal Widgets

HTML Properties in Polling Surveys  
You can dene HTML properties in polling surveys. While the steps for dening HTML properties for a polling survey
are the same as all other survey types, there is one exception that you need to be aware of. Style precedence depends
on the HTML tags dened in the customer portal.

If the customer portal web designer uses the !Important tag in the widget styling aributes, those styles take
precedence over the HTML properties you dene in the polling survey by clicking Display Options on the ribbon of the
New Question window. For customer portal widget styling aributes, see Polling Widgets.

• To dene HTML properties for a text question, see steps 5–7 in Create a Text Question.

• To dene HTML properties for a choice question, see steps 6–8 in Create a Choice Question.

• To dene HTML properties for a matrix question, see steps 5–7 in Create a Matrix Question.

Create a Questionnaire in Basic Mode  
The questionnaire is the main part of broadcast, transactional, and website link surveys. It consists of a set of questions
you want your customers to answer.

You must create a questionnaire for these types of surveys. From the Questionnaire tab, you have all the tools you need
to create a dynamic HTML survey. You can add your own content, along with new and previously created questions.
In your survey, you can add multiple pages to your questionnaire. This can help break up the survey into manageable
chunks. Customers see only questions on one page before proceeding to the next page.

You can create the questionnaire in either basic or advanced mode. In basic mode, you can design multi-page
questionnaires in a straightforward interface focused mainly on your survey presentation. In advanced mode, you can
design a ow diagram to present questionnaires, set criteria for survey branches, and trigger automated actions such as
sending notications, seing elds, and creating opportunities and incidents.

The following procedure describes how you can create a questionnaire in basic mode. See Create a Questionnaire in
Advanced Mode for the procedure for creating a questionnaire in advanced mode.

Note:  Questionnaires do not apply to polling surveys because polling surveys use a list of questions instead of
questionnaires. See Polling Surveys.

1. In an open survey, click the Questionnaire tab.
The Questionnaire tab opens on the content pane.
The Questionnaire tab is divided into sections. The main section shows the page you are editing and displays
the current content and questions in the questionnaire. When you create a questionnaire, this section is blank.
If there is more than one page in the questionnaire, you can scroll through the pages using the arrows at the
top of this section.

On the right side are options for the tasks you can perform on the questionnaire, such as adding a
question. The Page Tasks section contains options for the tasks you can perform on the specic page of the
questionnaire you are working on. The Survey Tasks section contains options for the tasks you can perform on
the entire survey. You can also right-click in the main section to select from the most common tasks.
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2. Enter eld information.

Buon Description

Add a Question
 

Click this buon to add a question to the questionnaire. See Add a Question to a Survey.
 

Add HTML Content
 

Click this buon to add HTML content to the questionnaire. See How the HTML Editor
Works.
 

Set Page Title
 

Click this buon to change the title of the page from the default “Page <page number>.”
See Set the Page Title.
 

Delete Page
 

CAUTION:  Deleting a page cannot be undone.

Click this buon to delete the page you are on and all of its content.
 
This buon is available only when the questionnaire contains more than one page.
 

3. Enter eld information.

Buon Description

Add a Page
 

Click this buon to add a page to the questionnaire. Customers see only one page at a
time when responding to the survey. When a page is added, the arrows at the top of the
main section are activated and you can scroll through the pages of your questionnaire
to add questions and content.
 

Organize Pages
 

Click this buon to organize pages in the questionnaire. See Organize Questionnaire
Pages.
 
This buon is available only when the questionnaire contains more than one page.
 

Apply Template
 

Click this buon to select a template to form the HTML in the questionnaire. See Apply a
Survey Template.
 
Templates are created through the Content Library. See How Templates Work.
 

Survey Options
 

Click this buon to set survey options, such as font aributes, progress indicators,
 buon properties, cookie options, and optimization for mobile devices. See Set Survey
Options.
 

End of Survey Options
 

Click this buon to set options that determine what happens when the survey is
submied. See Set End of Survey Options.
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Buon Description

 

Switch to Advanced Mode
 

Click this buon to create your questionnaire in advanced mode. See Create a
Questionnaire in Advanced Mode.
 
You must save the survey before you can switch to advanced mode. If you do not save
the survey before you click this buon, a message prompts you to save.
 

Preview
 

Click this buon to preview your survey in a web browser.
 

Mobile Preview
 

Click this buon to see how your survey looks on a mobile device.
 
Mobile preview is a limited, browser-based preview that gives you a general idea of how
your survey might look on a smaller device when you are designing your survey from
your desktop. With that in mind, always test your surveys on applicable mobile devices
and browsers before you launch them.
 

4. To select a template to use in the questionnaire, click Choose next to Survey Template at the boom of the
content pane. See Apply a Survey Template.

Note:  If a template is already being used in the questionnaire, its name displays in this section. You
can change templates or clear the content of the template from the questionnaire.

Basic Mode Survey Ribbon  
Options found on the ribbon when creating a survey in basic mode are described here.

Group/Buon Description

Save
 

Save
 

Click this buon to save the survey and keep it open for editing.
 

Save and Close
 

Click this buon to save the survey and close it.
 

Actions
 

New
 

Click this buon to create a new survey.
 

Survey URL
 

Click this buon to view the survey URL. The URL is automatically copied to your clipboard so you can
easily paste it into your browser.
 

Refresh
 

Click this buon to reload the survey reports.
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Group/Buon Description

Info
 

Click this buon to view identifying data about the survey, including the survey ID, date the survey
was created and updated, sta member who created and updated the survey, interface ID, ow ID, and
mailing ID.
 

Proong
 

Spelling
 

Click this buon to spell check the survey invitation message.
 

Preview
 

Standard
 

Click this buon to preview your survey in a web browser as it would be viewed from a standard web
device, such as a desktop or a laptop.
 

Mobile
 

Click this buon to see how your survey looks on a mobile device.
 

Note:  Mobile preview is a limited browser-based preview that gives you a general idea of
how your survey might look on a smaller device. With that in mind, always test your surveys
on applicable mobile devices and browsers before you launch them.

Add a Question to a Survey  
Adding questions is the most important part of creating your survey. You can add any questions already in Feedback or
create questions as needed.

1. Click Add a Question in the Page Tasks section.
The Select Question window opens.

Tip:  You can also add questions by hovering over the Questions tab to the right of the Page Tasks
section and then dragging a question from the list to the survey page. To make the Questions section
easier to access, you can dock it to the Questionnaire tab by clicking the Auto Hide icon at the top of
the Questions section.

2. To add an existing question, select it from the list and click OK or double-click the question.
To add multiple questions at the same time, press the Ctrl key while selecting each question you want to add.
When you drag multiple questions to the survey page, they are added in the order in which they were selected.

3. To create a new question, click New Survey Question.
A window opens where you can create a question. After you save the new question, it appears in the questions
list. See How Questions Work.

4. To reorder questions on the page, drag each question to its new position.
5. To open a question for editing, click Open.
6. To remove a question from the survey page, click Remove.
7. To move the question to another page of a multi-page questionnaire, click the arrow next to Remove and select

Move. The Move Item window opens.
a. Select a destination page from the list.
b. Click the Before Item drop-down menu to select the question you want the moved question to come

before.
c. Click OK to move the question to the specied location.
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Related Topics
• Best Practices for Writing Eective Questions

Set the Page Title  
You can change the title of the page you are editing from the default “Page <page number>.” The page title displays in
the title bar of the web browser when the survey is taken.

1. In your open questionnaire, click Set Page Title in the Page Tasks section.
The Set Page Title window opens.

2. Enter the name of the page in the Title eld.
This eld must contain a value.

3. Click OK.

Organize Questionnaire Pages  
If you have more than one page in your questionnaire, you can organize the pages by reordering, deleting, or adding
pages. You can also edit the page titles to change what displays to customers in the title bar of their web browser.

The system automatically creates a document for each page created in a questionnaire and stores it in the
Automatically Generated folder in the Documents explorer. When you update a page in the questionnaire, those
changes are also made to the automatically generated copy. See Automatically Generated Folders.

1. In your open questionnaire, click Organize Pages in the Survey Tasks section.
The Organize Pages window opens and displays a list of the pages in your questionnaire.

2. To add a page, click Add Page.
A page is added to the boom of the list.

3. To edit a page title, select the page you want to edit and click Edit Title. See Set the Page Title.
4. To delete a page from the questionnaire, select the page you want to delete and click Remove.

The page and all of its contents are deleted.

CAUTION:  Deleting a page cannot be undone.

5. To move a page up one position, select the page and click Move Up.
6. To move a page down one position, select the page and click Move Down.

Tip:  You can also drag and drop pages to adjust their position.

7. Click OK.

Apply a Survey Template  
You can use a template to add HTML above and below the content and questions in your questionnaire. Templates are
created through the Content Library.

1. In your open questionnaire, do one of the following:
◦ Click Apply Template in the Survey Tasks section.

◦ Click Choose next to Survey Template at the boom of the content pane.

The Choose Template window opens.
2. Select the template you want to use and click OK.

The template is applied to your questionnaire and the name of the template appears in the Survey Template
section.

3. To clear a template from your survey, do one of the following:
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◦ Click Clear Template on the Choose Template window.

◦ Click Clear next to Survey Template on the boom of the content pane.

Related Topics
• How Templates Work

Set Survey Options  
Specifying survey options lets you customize your questionnaire. You can set font aributes, choose how to notify
customers of their progress through your survey, and specify how you identify customers.

You can also add back buons to multiple-page surveys and change the default text of the buon labels. Any questions
that respondents answer are saved, making it easy to review or change answers from a previous page or to come back
at a later date to nish a survey.
Additionally, mobile optimization is applied, by default, from your survey options. Mobile optimization makes your
surveys user-friendly when taken on mobile devices. See Mobile Surveys.

1. In your open questionnaire, click Survey Options in the Survey Tasks section.
The Survey Options window opens.

2. Enter eld information.

Field Description

Font
 

Enter eld information in this section to dene the font aributes for the survey.
 

Apply Survey Font
 

Select this check box to set the font aributes in the survey.
 

Note:  If you used a template to create the survey and then set the font
aributes for the survey, the header and footer fonts dened in the template
do not change to the new font aributes.

Font Family
 

Click this drop-down menu to select the font family.
 

Font Size
 

Click this drop-down menu to select the font size.
 

Font Color
 

Click this box to open the Color window and set the font color in the survey. You can
select a color from the Basic colors or click Dene Custom Colors to dene a color.
 

Preview
 

Displays the font as it appears in the survey.
 

Progress Indication
 

Enter eld information in this section to determine how customers can see their
progress in the survey.
 

Display Question Numbers
 

Select this check box to display a number before each question. If cleared, questions
appear unnumbered.
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Field Description

 

Numbering Format
 

Click this drop-down menu to select the number format you want to appear before each
question.
 
This drop-down menu is available only when the Display Question Numbers check box
is selected.
 

Display Page Numbers
 

Select this check box to display page numbers at the top of each page of the survey (for
example, Page 1 of 3).
 
When this option is active, each question in a matrix is numbered in sequence with
any surrounding questions. For example, if a four-row matrix is added below two text
questions on the questionnaire, its rows are numbered 3, 4, 5, and 6.
 
This option is not available in advanced mode.
 

Display Progress
 

Select this check box to display a progress bar that shows customers how much of the
survey they have completed.
 
This option is not available in advanced mode.
 

Completed Color
 

Click this color box to select a color to designate the completed portion of the survey in
the progress bar.
 

Current Color
 

Click this color box to select a color to designate the current portion of the survey in the
progress bar.
 

Remaining Color
 

Click this color box to select a color to designate the remaining portion of the survey in
the progress bar.
 

Border Color
 

Click this color box to select a color as the border of the progress bar.
 

Buon Properties
 

Enter eld information in this section to change the properties of buons used in the
survey.
 

Buon Alignment
 

Click this drop-down menu to select left, center, or right alignment. Left is selected by
default.
 

Next Page
 

To change the label of the next page buon, which is set to Next by default, enter the
name of the label as you want it to display.
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Field Description

Final Page Submit
 

To change the label of the submit buon, which is set to Submit by default, enter the
name of the label as you want it to display.
 

Previous Page
 

Select this check box to add a back buon to your multiple-page survey. To change the
label of the back buon, which is set to Back by default, enter the name of the label as
you want it to display.
 

Class
 

Enter any class name you want to assign to the default buons. You must dene the
class in your HTML document by either using the <style> tag to dene the class inline,
 or posting the class in a CSS le on your web server and referencing it with the <link>
tag.
 

Style
 

Enter any style aributes you want to assign to the default buons. Style aributes
dene how the buons appear, such as color and font. For example, color: yellow; font-
weight: bold; background: blue; border: 2px outset red.
 

User Identication
 

Specify cookie seings in this section.
 

Use Cookie
 

Select this check box to identify customers completing the survey by the Oracle Service
Cloud cookie set on their computer. The customer is rst identied through URL
parameters in the email link to the survey, and, if none exist, the cookie is used.
 

Set Cookie
 

Select this check box to set a cookie for customers who are identied through the email
link to the survey.
 

Mobile
 

Set mobile optimization for surveys taken on mobile devices.
 

Apply Mobile Optimization
 

CAUTION:  By clearing this check box, surveys will not be optimized for
readability or touchscreen compatibility on mobile devices. While the survey
will still display on any device, the questions may not be easy to read and
responding may be dicult when a mobile device is used.

Clear this check box to disable optimization for mobile devices.
 

3. Click OK.

Set End of Survey Options  
You can determine what happens after customers submit a survey. For example, you can add the contact to a list, create
an opportunity, or send the customer an email.

A wizard helps step you through the process of the nal actions performed after a survey is submied. In addition, you
can specify where customers are routed, such as the default Thank You page or your own website.
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Note:  When a survey is responded to anonymously, survey actions that require contact identication are
disregarded. Feedback cannot create an incident or opportunity for an anonymous responder, add them to a
list, or send them a transactional mailing or survey.

1. In your open questionnaire, click End of Survey Options in the Survey Tasks section.

Step 1 in a polling survey is slightly dierent. In your open question list, click Polling Options on the ribbon to
open the Polling Survey Options window, where the End of Survey Actions section displays. Continue with step
2.

The End of Survey Options window opens.
2. Click Add Action to add an action that is performed when the survey is submied.

The Survey Final Action Wizard opens. See Add an Action with the Survey Final Action Wizard.
3. To edit an action, select the action and click Edit Action.
4. To delete an action, select the action and click Remove.
5. To move an action up one position, select the action and click Move Up.

The actions execute in the order they are listed.
6. To move an action down one position, select the action and click Move Down.

Tip:  You can also drag and drop actions to adjust their position.

7. Select the page you want to display after the survey is submied from the options listed in the Final Page
section.

Option Description

Redirect to default Thank You page
 

Select this option to use the default nal page. Customers are redirected to a Oracle
Service Cloud page that thanks them for their feedback.
 
You can edit this page through the File Manager using the cci/top.phph, head.phph,
 and boom.phph les. See Manage Files with the File Manager. To learn more about
customizing Outreach and Feedback pages, see  Answer ID 2477  on our support site.
 

Redirect to URL
 

Select this option and enter a URL to redirect customers to a specic website. See Edit
Redirect to URL Aributes.
 

Open URL
 

Click this icon to open the URL.
 

Add
 

Click this icon to add a contact, incident, opportunity, or tracked link merge eld to the
URL. See Insert a Text Merge Field.
 

Display nal page without buons
 

Select this option to display the nal page of the survey without a Submit buon.
 
If you select this option, your survey should have more than one page with no questions
on the last page, since answers cannot be submied.
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8. Click OK.

Add an Action with the Survey Final Action Wizard  
When seing end of survey options, the Survey Final Action wizard steps you through the process of adding an action
to the end of your survey.

You can choose from several actions and also specify whether the action occurs at the end of all survey submissions or
just when a survey score has been met. See Set End of Survey Options.

1. From the End of Survey Options window, click Add Action.
The Survey Final Action Wizard opens.

2. Click Next.
3. Select the action you want to perform from the nal action type options.

Action Type Description

Add the Survey Contact to a List
 

Select this option to add the customer to a contact list after submiing the survey.
 

Create an Opportunity
 

Select this option to create an opportunity in Opportunity Tracking using the customer
information.
 

Create a Notication
 

Select this option to send an email to sta members notifying them that the survey has
been submied.
 

Create an Incident
 

Select this option to create an incident in Service using the customer information.
 

Create a Lead
 

Select this option to create a lead in Opportunity Tracking using the customer
information.
 

Execute Object Event Handler
 

Select this option to create a contact-related object event handler using customer
information.
 

Send an Email to a Contact
 

Select this option to send a transactional mailing to the customer.
 

Set a Field Value
 

Select this option to set a eld in the contact record for the customer.
 

Execute an External Event
 

Select this option to execute an external event after the survey is submied.
 

4. Click Next. The next page that displays depends on the action you selected in the previous step. On this page
of the wizard, you can set details for the action.

◦ Add the Survey Contact to a List—See Edit Add to List Aributes.

◦ Create an Opportunity—See Edit Opportunity Aributes.

◦ Create a Notication—See Edit Notication Aributes.
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◦ Create an Incident—See Edit Incident Aributes.

◦ Create a Lead—See Edit Lead Aributes.

◦ Execute Object Event Handler—See Edit Execute Object Event Handler Aributes.

◦ Send an Email to a Contact—See Edit Transactional Mailing Aributes.

◦ Set a Field Value—See Edit Set Field Aributes.

◦ Execute an External Event—See Edit External Event Aributes.

5. Click Next.
6. Select when the action should be performed.

Option Description

Every time the survey is completed
 

Select this option to perform the action every time the survey is submied.
 

When the completed survey score is
 

Select this option and enter a survey score to send the survey only when the survey
is equal to, less than, greater than, or between certain scores. For information about
question scores, see Create a Choice Question.
 

7. Click Finish to add the action.
8. Click OK.

Tip:  The actions available in the Survey Final Action Wizard are also available as standards elements
when editing in advanced mode.

Create a Questionnaire in Advanced Mode  
If you want to create more detailed questionnaires, you can do so in advanced mode. Feedback provides an intuitive
graphical interface for creating and editing advanced surveys.

For example, to add survey branching, you can use the Decision element or the Case Statement element. See Edit
Decision Aributes and Edit Case Statement Aributes . When creating and editing an advanced survey, you perform
most tasks using the ribbon, canvas, and survey components. These resources provide all of the tools and elements you
need to design an advanced survey.

1. Click Switch to Advanced Mode in the Survey Tasks section.

When you switch to advanced mode, the default questionnaire displays a survey page element, a Submit connector,
and a Redirect to URL element that is dened (by default) to display a thank you page when the contact clicks the
Submit buon. This ow represents the simplest form of an advanced survey that you can send. See Edit Redirect to
URL Aributes.

Related Topics
• How You Edit Element Aributes

• Design an Advanced Survey Flow Diagram
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Advanced Mode Survey Ribbon  
The advanced mode ribbon features two additional tabs, Designer Home and View, from which you can access options
to create or edit an advanced survey. Each tab on the ribbon has one or more groups containing options you can use to
modify the survey or elements on the canvas.

Advanced Survey Designer Home Tab  
The Home tab in advanced surveys gives you access to basic editing functions, survey components, and aributes that
impact the entire survey.

From the Advanced Survey Designer Home tab, you can specify certain survey options to customize your questionnaire.
You can set the font aributes and choose how to notify customers of their progress through your survey. You can also
specify how the system identies contacts. See Set Survey Options in Advanced Mode.

Group/Buon Description

Elements
 

The buons in this group let you add survey components to your ow diagram. For a description of
available components, see Design an Advanced Survey Flow Diagram.
 

Tip:  Components can also be accessed from the toolbox.

Survey Tasks
 

The buons in this group provide options to change the overall appearance of the survey.
 

Survey Options
 

Click this buon to access seings for default font formaing, question numbering, and user
identication.
 

Apply Template
 

Click this buon to select or clear a survey template. See Apply a Survey Template.
 

Switch to Basic Mode
 

CAUTION:  Switching to Basic mode cannot be undone and any changes made in advanced
mode are lost.

Click this buon to switch the survey to Basic mode.
 

Validate
 

Click this buon to check the survey workow for errors. See Survey Validation.
 

Clipboard
 

The buons in this group provide access to basic editing commands when working with components
on the canvas.
 

Paste
 

Click this buon to paste the contents of the clipboard.
 

Cut
 

Click this buon to cut selected components from the canvas to the clipboard.
 

Copy
 

Click this buon to copy selected components from the canvas to the clipboard.
 

Delete
 

Click this buon to delete selected components from the canvas.
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Set Survey Options in Advanced Mode  
You can specify certain survey options to customize your questionnaire from the Designer Home tab.

1. Click Survey Options on the Designer Home tab.
Depending on your screen size, you may need to click  Survey Tasks > Survey Options .
The Survey Options window opens.

2. Enter the eld information.

Field Description

Font
 

Enter eld information in this section to dene the font aributes for the survey.
 

Apply Survey Font
 

Select this check box to set the font aributes in the survey.
 

Note:  If you used a template to create the survey and then set the font
aributes for the survey, the header and footer fonts dened in the template
do not change to the new font aributes.

Font Family
 

Click this drop-down menu to select the font family.
 

Font Size
 

Click this drop-down menu to select the font size.
 

Font Color
 

Click this box to open the Color window and set the font color in the survey. You can
select a color from the Basic colors or click Dene Custom Colors to dene a color.
 

Preview
 

Displays the font as it appears in the survey.
 

Progress Indication
 

Enter eld information in this section to determine how customers can see their
progress in the survey.
 

Display Question Numbers
 

Select this check box to display a number before each question. If cleared, questions
appear unnumbered.
 

Numbering Format
 

Click this drop-down menu to select the number format you want to appear before each
question.
 
This drop-down menu is available only when the Display Question Numbers check box
is selected.
 

User Identication
 

Specify cookie seings in this section.
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Field Description

Use Cookie
 

Select this check box to identify customers completing the survey by the Oracle Service
Cloud cookie set on their computer. The customer is rst identied through URL
parameters in the email link to the survey, and, if none exist, the cookie is used.
 

Set Cookie
 

Select this check box to set a cookie for customers who are identied through the email
link to the survey.
 

Mobile
 

Set mobile optimization for surveys taken on mobile devices.
 

Apply Mobile Optimization
 

CAUTION:  By clearing this check box, surveys will not be optimized for
readability or touchscreen compatibility on mobile devices. While the survey
will still display on any device, the questions may not be easy to read and
responding may be dicult when a mobile device is used.

Clear this check box to disable optimization for mobile devices. See Mobile Surveys.
 

3. Click OK.

Advanced Survey Designer View Tab  
The View tab in advanced surveys mode provides access to the toolbox and options for changing your view of the
design canvas, including displaying design grid elements and adjusting the zoom level. These options make it easier to
review and edit your ow diagram.

Group/Buon Description

Survey Components Toolbox
 

Click this buon to display the toolbox.
 

Canvas
 

The check boxes in this group let you select canvas options.
 

Labels
 

Select this check box to display labels for elements in the diagram. Labels display by default.
 

Connector Labels
 

Select this check box to display labels for connectors in the diagram. Connector labels display by
default.
 

Validation Results
 

Select this check box to display validation icons in the diagram.
 

Grid
 

Select this check box to display the canvas grid. The canvas grid displays by default.
 

Grid Size
 

Click this drop-down menu to select the size of the canvas grid. The canvas grid is set to Medium by
default.
 

Zoom The buons in this group let you select a zoom level for the canvas.
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Group/Buon Description

   

Zoom
 

Click this buon to access the Zoom Options window. See Set Zoom Options.
 

100 percent
 

Click this buon to view the canvas at its normal size.
 

Fit To Screen
 

Click this buon to adjust the zoom level to show all elements.
 

Extents
 

Click this buon to show the entire canvas.
 

Set Canvas Options  
The following procedure describes the steps for customizing your canvas options on the View tab in advanced surveys.

1. To display labels for connectors on the canvas, select  Connector Labels on the View tab.
2. To display validation results on the canvas, select Validation Results. See Survey Validation.
3. To display the canvas grid, select Grid.
4. To change the size of the canvas grid, click the Grid Size drop-down menu and select from Small, Medium, or

Large.

Set Zoom Options  
You can set zoom options that are available from the View tab.

1. Click Zoom on the View tab.
The Zoom Options window opens.

2. To specify a desired zoom level, select an option in the Zoom To section.
a. To adjust the zoom level to show all components, select Fit to Screen.
b. To show the entire canvas, select Extents.

3. Enter a zoom percentage in the Percent eld. Click the up or down arrow to increase or decrease the value.

Tip:  You can also change the magnication of the canvas using the zoom slider located in the boom
right corner of the Service Console.

4. Click OK.

Campaign and Survey Element Tools Tab  
When you select an element on the canvas of a campaign or an advanced survey, the design ribbon displays a
contextual tab called the Element Tools tab.

The contextual tabs that display on the ribbon depend on your selection. When you select an element or a connector,
the ribbon displays a fourth contextual tab. When an element is selected, the Element Tools tab displays. The Element
Tools tab is divided into two sections. On the left are contextual groups and options, meaning they change depending
on the element selected. On the right are standard groups and options, meaning they display no maer what element is
selected.

Group/Buon Description

Label
 

The options in this group let you change the font style, size, and color. You can select font aributes,
 such as bold and italic, and change the text alignment.
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Group/Buon Description

(Label Position)
 
 

Click this icon to select the position of the label relative to the element. The default label position of a
new element is Inside.
 

 

Click this icon to enter the text of the element label.
 
You can also edit the label text inline by clicking the element label.
 

Notes
 

Click this option to enter notes about the element.
 

Size
 

The options in this group let you change the height and width of the element.
 

Campaign and Survey Path Tools Tab  
When you select a connector on the canvas of a campaign or an advanced survey, the design ribbon displays a
contextual tab called the Path Tools tab.

The options on this tab let you format the connector and change the connector type. See Connectors in Campaigns and
Connectors in Surveys.

Group/Buon Description

Type
 

Click this drop-down to change the type of the selected connector.
 
A connector type can be changed only when it is not connected to a standard or event-triggering
element.
 

Style
 

The options in this group let you change the line style of the selected connector.
 

Straight
 

Click this option to set the connector line style to straight.
 

Square
 

Click this option to set the connector line style to square.
 

Rounded Square
 

Click this option to set the connector line style to rounded square.
 

Curved
 

Click this option to set the connector line style to curved.
 

Design an Advanced Survey Flow Diagram  
The rst step in creating a survey in advanced mode is to design a ow diagram. The ow diagram is a graphical
representation of the survey “ow,” the actions and decisions your survey will perform, and the order in which it will
perform them.
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Your ow diagram can be as simple as a single path connecting a few actions, or it can be complex, routing your
audience through dozens of actions, paths, and decision points. With its simplied graphical interface, Feedback makes
creating even a complex workow as easy as clicking and dragging components into a logical order.
Whether your business needs are simple or complex, you should start by reviewing the elements available in the toolbox
and consider how each might help accomplish the key objectives of your survey. When you have a clear idea which
elements will be useful, you can create the ow diagram by dragging them from the toolbox to the canvas, inserting
each element in a logical position, and connecting them to dene the sequence of actions. After an element has been
inserted, you can double-click it to open a window where you can edit its aributes.

Tip:  When explaining aributes that can be edited on a window or the ribbon, we describe the procedure
using the window. However, keep in mind that the ribbon provides easy access to most of the same aributes
available on windows, without the need to double-click. Survey elements can also be dragged to your ow
diagram from the Elements groups on the Designer Home tab.

When a survey is launched and a contact performs the rst action, the decisions and actions in the survey are evaluated
and executed in the sequence you have specied. For example, when a contact submits a web form, your campaign
evaluates the information provided and executes the next action, such as creating a sales lead and sending a follow-up
message to the contact.

Note:  When a survey is responded to anonymously, survey actions that require contact identication are
disregarded. Feedback cannot create an incident or opportunity for an anonymous responder, add them to a
list, or send them a transactional mailing or survey.

If you switch to advanced mode before adding anything to the questionnaire, the canvas initially displays the
components of a basic survey: a blank web form with a submit buon that redirects to the Feedback standard Thank
You page. These elements serve as the starting point for your design. You can add, edit, or remove elements to
customize the questionnaire to t your needs.

1. Drag and drop a survey element from the toolbox onto the canvas.

Element Description

Event Triggering Elements
 

Event-triggering elements serve as starting points for questionnaires.
 

Survey Page
 

Drag and drop this element to add a survey page to the questionnaire. After adding this
element, double-click it to add content to the page. See Edit a Survey Page.
 

Serve Web Page
 

Drag and drop this element to serve a web page. After adding this element, double-click
it to dene its aributes. See Edit Serve Web Page Aributes.
 

Conditional Elements
 

Conditional elements produce multiple path outcomes based on decisions.
 

Decision
 

Drag and drop this element to add a decision point. A decision lets you specify
conditions the contact must meet to advance in the workow. You can create two
outgoing paths from a decision: Yes (contact meets the criteria) and No (contact does
not meet the criteria). See Connectors in Surveys.
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Element Description

After adding the decision, double-click it to dene its aributes. See Edit Decision
Aributes.
 

Case Statement
 

Drag and drop this element to add a case statement to the survey. A case statement is
a type of conditional element that lets you add multiple choice decisions. This give you
an easy way to add diverse branching capabilities to your surveys based on conditions
dened in the workow. Case statements are unique because they have an outgoing
path for every condition. As soon as the rst choice (condition) is matched, the path for
that choice is followed, and no other conditions within the case statement are evaluated.
See Connectors in Surveys. After adding the case statement, double-click it to dene its
aributes. See Edit Case Statement Aributes .
 

Standard Elements
 

Standard items perform actions when specied criteria are met.
 

Notication
 

Drag and drop this element to send a notication to one or more sta members.
After adding this element, double-click it to dene its aributes. See Edit Notication
Aributes.
 

Redirect to URL
 

Drag and drop this element to redirect the contact to a URL. After adding this element,
double-click it to dene its aributes. See Edit Redirect to URL Aributes.
 

Incident
 

Drag and drop this element to create an incident from the contact record. After adding
this element, double-click it to dene its aributes. See Edit Incident Aributes.
 

Opportunity
 

Drag and drop this element to create an opportunity from the contact record. After
adding this element, double-click it to dene its aributes. See Edit Opportunity
Aributes.
 

Lead
 

Drag and drop this element to create a lead from the contact record. After adding this
element, double-click it to dene its aributes. See Edit Lead Aributes.
 

Add to List
 

Drag and drop this element to add the contact to a list. After adding this element,
double-click it to dene its aributes. See Edit Add to List Aributes.
 

Set Field
 

Drag and drop this element to set a value for one of the elds in the contact record.
After adding this element, double-click it to dene its aributes. See Edit Set Field
Aributes.
 

Execute Object Event Handler
 

Drag and drop this element to add a contact-related object event handler that will
trigger an external event action. See Edit Execute Object Event Handler Aributes.
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Element Description

Transactional Mailing
 

Drag and drop this element to send a transactional mailing to the contact. After adding
this element, double-click it to dene its aributes. See Edit Transactional Mailing
Aributes.
 

Transactional Survey
 

Drag and drop this element to send a transactional survey to the contact. After adding
this element, double-click it to dene its aributes. See Edit Transactional Survey
Aributes.
 

External Event
 

Drag and drop this element to run an external event. External events are scripts that run
outside of Oracle Service Cloud After adding this element, double-click it to dene its
aributes. See Edit External Event Aributes.
 

Artifacts
 

Artifact elements let you make comments about your survey. They do not aect the
outcome of your ow diagram.
 

Comment
 

Drag and drop this artifact to add comments about your ow diagram or a specic
survey component. A comment artifact does not require a connector, but if your
comment is about a specic element, use the Artifact connector type. See Connectors in
Surveys.
 

2. To edit the aributes of an element on the canvas, double-click the element. See How You Edit Element
Aributes.

3. To connect one element to another, click an anchor on the rst element and drag the connector to an anchor on
the second element. See Connectors in Surveys.

4. To cut, copy, or paste one or more components, click the appropriate option on the Clipboard group of the
Designer Home tab.

5. To export an image of the canvas to your workstation, click  File > Export Image .
6. To change the formaing of an element, select the element and see the following table. See Campaign and

Survey Element Tools Tab.

Tip:  To select multiple elements at the same time, press Ctrl and select each element.

Connectors in Surveys  
Connectors are components used to link survey elements and indicate ow direction. Elements can be connected to
other elements depending on their type. The type of connector is indicated by its color.

Each element can have a specic number of incoming and outgoing connectors. This table lists the number of
connectors allowed for each element.

Path Color Description

Submit
 

Blue
 

This type of connector submits the element web form elds to the database
and then links to another element. A web form can be a document with a
web form or survey questions.
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Path Color Description

 

Note:  In order for the submit connector to work, there must be a
submit action on the web form that’s used in the campaign. See
Insert a Survey Results Link.

Yes
 

Green
 

This type of connector links a decision element to another element. The path
is taken if the contact meets the criteria specied in the decision.
 

No
 

Red
 

This type of connector links a decision element to another element. The path
is taken if the contact does not meet the criteria specied in the decision.
 

Standard
 

Gray
 

This type of connector links one element to another element. The second
action is performed immediately after the rst.
 

Artifact
 

Black (Dashed)
 

This type of connector links a comment to an element.
 

Case
 

Gray
 

This type of connector links a case statement element to another element.
The path is taken if the contact meets the criteria specied in the case
statement.
 

Each element can have a specic number of incoming and outgoing connectors. See the following table for a list of the
number of connectors allowed in each element.

Element Connectors Allowed

Add to List
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Case Statement
 

Unlimited incoming connectors
 
1 outgoing connector for each choice.
 

Decision
 

Unlimited incoming connectors
 
1 outgoing Yes connector
 
1 outgoing No connector
 

Execute Object Event Handler
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

External Event
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Incident Unlimited incoming connectors
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Element Connectors Allowed

   
1 outgoing standard connector
 

Lead
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Notication
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Opportunity
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Redirect to URL
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Serve Web Page
 

Unlimited incoming connectors
 
1 outgoing standard connector
 
1 outgoing submit connector
 

Survey Page
 

Unlimited incoming connectors
 
1 outgoing standard connector
 
1 outgoing submit connector
 

Set Field
 

Unlimited incoming connectors
 
1 outgoing standard connector
 

Transactional Mailing
 

Unlimited incoming connectors
 
1 outgoing standard connector
 
1 outgoing submit connector
 

Transactional Survey
 

Unlimited incoming connectors
 
1 outgoing standard connector
 
1 outgoing submit connector
 

Connect an Element  
Connectors are used to link elements and show ow direction. Elements can be connected to other elements depending
on their type. The type of connector is indicated by its color.
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The anchor is highlighted when the connector is able to link to it. The connector arrow will point from the rst element
to the second. When you connect your element types this way, the system automatically applies the correct connector
type.

1. Click an anchor on the rst element and drag the connector to an anchor on the second element.

Note:  If you use the wrong connector type, the element anchor will not be highlighted.

Other ways to connect elements include the following:

◦ Hover over the rst element and click a blue arrow to link to an adjoining element.

◦ Drag one element over another, hover over its blue arrow until it turns dark blue, and then drop to
connect the elements. Connecting your elements this way auto-links them with the correct connector
type.

◦ Click an element from the toolbox, and then hover over an element on the canvas and click its blue arrow
to drop and auto-link the new element.

◦ Drag and drop a connector from the toolbox to the canvas, and then drag the ends of the connector to
the elements you want to link.

Related Topics
• Connectors in Campaigns

• Connectors in Surveys

Connect to a Dierent Element  
You can change the ow of your existing elements by moving a connector to a dierent element.

1. Click a midpoint on the connector to select it and drag one of its ends to an anchor on a dierent element.
The element will highlight when you can connect to it. Remember, if you try to use the wrong connector type,
your element will not be highlighted.

Edit a Square or Curved Connector  
You can adjust the shape of the connection on square and curved connectors.

These images show the calibration points on square and curved connectors.
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1. Click a midpoint on a square or curved connector to select it and drag the calibration points to change the
connection shape.

Delete a Connector  
You can delete connector components.

1. Click a midpoint on the connector to select it and press Delete.

How You Edit Element Aributes  
After you have added an element to the canvas, you must edit its aributes to make it functional. For example, if you
add a survey page to the canvas, you need to edit it and add the questions that will appear on that page.

The following elements can be added to an advanced survey:

• Edit a Survey Page

• Edit Serve Web Page Aributes

• Edit Decision Aributes

• Edit Case Statement Aributes

• Edit Notication Aributes

• Edit Redirect to URL Aributes

• Edit Incident Aributes

• Edit Opportunity Aributes

• Edit Lead Aributes

• Edit Add to List Aributes

• Edit Set Field Aributes

• Edit Execute Object Event Handler Aributes

• Edit Transactional Mailing Aributes

• Edit Transactional Survey Aributes

Note:  You must dene aributes for each component added or a validation error occurs when aempting to
save the survey. See Survey Validation.

Edit a Survey Page  
After you add a Survey Page element to your ow diagram, you can edit its aributes to add questions and HTML
content, set the page title, and dene the buons you want to use on your page.

For multiple-page surveys, you can add next and previous buons to your pages. Because the next buon performs
a submit function when it is clicked, after respondents nish a page and perform a submit, answers from that page
are saved so they can easily go back and forth between pages. This makes it easy to review or change answers from a
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previous page or to come back at a later date to nish a survey. You can also customize the appearance of the buon
text and style aributes to make it more applicable for each survey page.

For best practices about using back and next buons, see Standard element placement when using next and back
buons.

1. Double-click the Survey Page element.
The New Survey Page window opens.

2. Click an option in the Page Tasks section.

Buon Description

Add a Question
 

Click this buon to add a question to the questionnaire. See Add a Question to a Survey.
 

Add HTML Content
 

Click this buon to add HTML content to the questionnaire. See How the HTML Editor
Works.
 

Set Page Title
 

Click this buon to change the title of the page from the default “Page <page number>.”
See Set the Page Title.
 

Modify Buons
 

Click this buon to modify the text of the buons or remove buons from a page. See
Modify Buons.
 

Modify Buons  
After you add a Survey Page element to your ow diagram, you can dene the buons you want to use on your page.

1. Click Modify Buons in the Page Tasks section.
The Set Buon Properties window opens.

2. Enter eld information.

Field Description

Buon Alignment
 

Click this drop-down menu to select left, center, or right alignment. Left is selected by
default.
 

Show next buon on page
 

CAUTION:  Because the next buon performs a submit function for each
page, do not remove the next buon from survey pages that have questions
on them. Otherwise, responders cannot submit their answers.

This check box, which is selected by default, displays a next buon and performs a
submit function when you add subsequent pages to your survey. If you clear this check
box, the remaining elds are disabled.
 

Text
 

To change the label of the next buon, which is set to Submit by default, enter the name
of the label as you want it to display.
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Field Description

 

Class
 

Enter any class name you want to assign to the buon. You must dene the class in your
HTML document by either using the <style> tag to dene the class inline, or posting the
class in a CSS le on your web server and referencing it with the <link> tag.
 

Style
 

Enter any style aributes you want to assign to the buon. Style aributes dene how
the buon appears, such as color, font, and alignment (for example, font-family: arial,
sans-serif; font-weight: bold; background: #9900; margin-left: 20px).
 

Show previous buon on page
 

Select this check box to display a previous buon on your page.
 

Text
 

To change the label of the previous buon, which is set to Back by default, enter the
name of the label as you want it to display.
 

Class
 

Enter any class name you want to assign to the buon. You must dene the class in your
HTML document by either using the <style> tag to dene the class inline, or posting the
class in a CSS le on your web server and referencing it with the <link> tag.
 

Style
 

Enter any style aributes you want to assign to the buon. Style aributes dene how
the buon appears, such as color, font, and alignment (for example, font-family: arial,
sans-serif; font-weight: bold; background: #9900; margin-left: 20px).
 

3. Click OK.

Edit Serve Web Page Aributes  
After you add a Serve Web Page element to your ow diagram, you can edit its aributes to select a document to serve
as a web page through Oracle Service Cloud.

You can specify the shortcut ID used to generate the URL and choose whether to prell the web form in the document
with contact elds stored in the contact’s cookies or passed as parameters in the URL. You can also customize the title
of the page you are editing. The page title displays in the title bar of the web browser when the survey is taken.

Tip:  Use a submit connector to connect this action to the next action when the web page contains a web form
or survey questions. You can also add a back buon to a web page that contains a web form. See Add a Back
Buon to a Serve Web Page.

1. Double-click the Serve Web Page element.
The Serve Web Page window opens.

2. Enter the name of the element in the Label eld.
3. Enter eld information.

1650



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Field Description

*Documents
 

Select the document you want to use as a web page from this list.
 
To search for a document, right-click the list and select Search. Then enter the
document name in the Find eld.
 

New Document
 

Click this text to create a document. See Create a Document.
 

*Shortcut ID
 

Enter the shortcut ID that is used to format the URL in this eld. The URL for the
document will be:
 
hp://<your_domain>/ci/documents/detail/2/<shortcut_ID>
 

Note:  This shortcut ID must be unique for all Serve Web Page elements in all
surveys and campaigns.

(View Web Page)
 
 

Click this icon to open the web page in a browser.
 
The icon is inactive until the campaign is launched. If the shortcut ID is edited after
launching, the icon is inactive until the campaign is saved.
 

Copy URL
 

Click this icon to copy the web page URL to the clipboard.
 
The URL will not be valid until the campaign is launched.
 

*Friendly Name
 

Enter the name of your web page. This name is used when linking to the web form from
another document.
 

Title
 

Enter the name of the page as you want it to display in the title bar of the web browser
when the survey is taken.
 
If you leave this eld blank, either the document title or the template title will display in
the web browser title bar. If a template has been applied to the document the web page
uses, then the template title is used.
 

4. Click the User Identication tab.
You can specify default values for the seings on the User Identication tab by editing optional conguration
seings. See Customize Feedback Conguration Seings.

5. Enter eld information.
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Field Description

Identify User By
 

Select from the following options to prell a web form (if one is included in your
document).
 

Login with Password
 

Select this option to require the contact to log in to the customer portal before viewing
the web form.
 

Remember Previous Login
 

Select this check box to identify the contact through the contact’s Oracle Service Cloud
login cookie. If a login cookie does not exist, the contact is redirected to the login page
on the customer portal. If this check box is cleared, the contact is always required to log
in through the customer portal before viewing the web form.
 

Other Credentials
 

Select this option to identify the contact by a cookie or through URL parameters.
 

Cookie
 

Select this option if you want to use the contact’s browser cookie to prell the web form.
The contact’s record is updated with the form submission.
 

Email Click-Through Parameters
 

Select this option if you want to use parameters passed in the URL to prell the web
form.
 

Tip:  If using this option to prell a web form from a link in a mailing, be sure
to use a web page link instead of a tracked link. Because tracked links are used
to redirect to external sites, they do not support click-through parameters.

Do Not Identify
 

Select this option if you do not want the web form to prell. This applies only to single
page surveys or campaigns with only one Serve Web Page element. For surveys and
campaigns with more than one page, after the contact info is added to the rst page,
 the subsequent pages will prell. Therefore, this option applies only to the rst instance
of a page in a survey or campaign ow that uses a Submit connector.
 
For example, most surveys use a Submit connector on the rst page that ows to the
next page with another Submit connector, and so on. In this case, the rst page will not
prell since the contact has not been identied. However, after the rst page has been
submied, the next page that loads will be associated to that contact. Therefore, any
web form elds on that page (as well as on subsequent pages) will prell even though
Do Not Identify is selected.
 

Note:  A contact record is updated through the web form if the email address
eld is included and can be matched to an existing record.
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Field Description

Set Browser Cookie on Submit
 

Select this check box if you want to set the contact’s browser cookie upon submiing
the form. If the contact accesses any form later, the form will be prelled if the Cookie
option is selected for that form.
 

Tip:  You can set default values for the user identication elds by editing the conguration seings
located in Outreach and Feedback/General/Campaigns. Note that default values specied by these
seings impact both new campaigns and new advanced surveys.

6. To add any notes associated with the element, click the Notes tab and enter the notes.
7. Click OK.

Add a Back Buon to a Serve Web Page  
You can add a back buon to a web page that contains a web form.

1. From an advanced survey, double-click the Serve Web Page element.
The Serve Web Page window opens.

2. Click New Document.
3. From the HTML tab of your document, click Begin With Blank Content.

The HTML editor opens.
4. Click Web Form in the Forms section of the Toolbox. See Insert a Survey Results Link.

Note:  Form elds cannot be added outside of a web form.

5. Click Submit Buon to add a submit buon to your web form.
Web forms must contain a submit buon.

6. To add a back buon to your content, click Back Buon.
7. To edit the label of the back buon, double-click the buon and enter the label as you want it to display.

Edit Decision Aributes  
Decision elements let you branch your workow based on two outgoing paths you dene.

After you add a Decision element to your ow diagram, you can edit its aributes to require contacts to meet certain
criteria before moving down the Yes path. Contacts who do not meet the criteria are moved down the No path (if one
exists). When you edit the decision, you can dene conditions based on contact elds or question responses and a
logical expression based on the conditions.

When you create decisions in campaigns or advanced questionnaires, you can create branches in your survey based
on customer response. For example, you could serve a document with survey questions as a web page, then create a
decision based on a response to send them to one of two documents containing additional questions.

Also, when a matrix question is added to an advanced questionnaire, each question from the matrix can be ltered by
decision elements. In this way, you can direct the ow based on a specic contact response to an individual question in
the matrix.

1. Double-click the Decision element to open the Decision Conditions window.
2. Enter the name of the decision in the Label eld.
3. Click Add Condition to create a condition for the Yes path. The Add Condition window opens.

a. Enter the name of the condition in the Name eld.
b. Click the Source drop-down menu and select a database eld or survey question.
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Note:  When adding a text eld to a decision, the Source drop-down menu displays an additional
item as “<text eld name> SmartSense.” Selecting the Smart Sense item lets you evaluate the
customer’s emotional state or aitude based on the words or language the customer used when
responding to the question. You can then specify values from Very Happy to Very Angry as
criteria for your decision logic.

c. Click the Operator drop-down menu and select the logical symbol that completes the condition.
d. Enter the value of the eld or click the drop-down menu and select the value in the Value eld.
e. Click OK to add the condition to the decision.

This expression determines which contacts meet the condition (for example, State/Province=MT or
<menu question>=<specied answer>).
By default, when multiple conditions are added, they are joined by AND. When the AND operator is used,
contacts are moved down the Yes path when all the conditions are met. You can further limit your data
set by using the Boolean operators OR and NOT. When the OR operator is used, contacts are moved
down the Yes path when any of the conditions are met.

4. To add an OR to your expression, click Add OR Node.
Conditions aached to the OR node are joined by OR.

5. To edit a condition, select the condition and click Edit Condition.
6. To delete a condition, select the condition and click Remove Condition.

The Add OR Node, Edit Condition, and Delete Condition options display only after you have added a condition.
7. Click View Text Denition to see your conditions as a logical expression.
8. To add any notes associated with the element, click the Notes tab and enter the notes.
9. Click OK.

Edit Case Statement Aributes  
Case statements help you branch your workow based on multiple conditions you dene. They are unique because
you dene an outgoing path for each condition. When the rst choice (condition) is matched, the path for that choice is
followed, and no other conditions within the case statement are evaluated.

After you add a case statement element to your ow diagram, you can edit its aributes to branch your ow to dierent
paths based on whether contacts meet certain conditions. When you edit the case statement, you can dene multiple
conditions using a contact eld in the database, a question, or a score.

Score pertains to the cumulative score from all preceding survey question responses. Score always displays on the
Cases tab.

Case statements dier from decisions because they let you add multiple paths to your ow. This image shows a case
statement with four choices that lead to three dierent paths.
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1. Double-click the Case Statement element.
The Case Statement window opens.

2. Select a contact eld, survey question, or score from the Cases tab.

Tip:  Depending on the item you select, choices are either already dened by default or you must
dene them.

3. If you want to add an “other” path to your case statement, select Include Option for Other.
4. To add a choice that is not dened by default, click Add Choice.

The boom section of the Case Statement window displays options to dene logical expressions for your
choices.
The Add Choice buon does not display if choices have already been dened by default. For example, Contact
Type or Global Opt-in under Default Contact Fields have choices dened. Therefore, the Add Choice buon
does not display when these elds are selected.

5. Click the Operator drop-down menu to select the logical symbol that completes your expression.
6. Enter the eld value in the Choice eld.
7. To add another choice that is not dened by default, repeat steps 4 through 6.
8. To delete a choice, select the choice and click Remove.
9. To add a choice that is dened by default, select the check boxes next to the choices you want to include in your

case statement.
Cases with menu, yes/no, and opt-in items present you with default choices dened by the database.

10. To add any notes associated with the element, click the Notes tab and enter the notes.
11. Click OK.

Edit Notication Aributes  
After you add a Notication element to your ow diagram, you can edit its aributes to dene which sta members to
notify.

1. Double-click the Notication element.
The Notication window opens.

2. Enter the name of the element in the Label eld.
3. Enter the message you want to appear in the subject line of the notication in the Message eld.
4. Select the check boxes of the sta members you want to notify.
5. To add any notes associated with the element, click the Notes tab and enter the notes.
6. Click OK.
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Edit Redirect to URL Aributes  
Redirect to URL elements let you dene a web page your customers are redirected to when they complete the previous
action in the workow. After adding a Redirect to URL element to your ow diagram, you can edit its aributes to
specify the URL you want to send the contact.

Note:  The Redirect to URL element that displays when you switch to advanced mode is dened (by default) to
display a thank you page when the contact clicks the Submit buon on the survey page (which is also dened
by default).

1. Double-click the Redirect to URL element.
The Redirect to URL window opens.

2. Enter the name of the element in the Label eld.
3. Enter the URL of the website you want to redirect the contact to in the URL eld.

The protocol must be specied. The following protocols are supported:

◦ le:///

◦ ftp://

◦ gopher://

◦ hp://

◦ hps://

◦ mailto:

◦ nntp:

◦ news:

4. To open the URL in a browser, click the Open URL icon to the right of the URL eld.
5. To add a contact, incident, opportunity, or tracked link eld to the URL as a parameter, click the Merge Field

icon (to the right of the Open URL icon). See Insert a Text Merge Field.
6. To add any notes associated with the element, click the Notes tab and enter the notes.
7. Click OK.

Edit Incident Aributes  
After you add an Incident element to your ow diagram, you can edit its aributes to dene the subject, status, and
other elements of the created incident.

1. Double-click the Incident element.
The Incident window opens.

2. Enter the name of the element in the Label eld.
3. Enter eld information.

Field Description

*Subject
 

Enter the subject of the incident in this text box.
 

*Status
 

Click this drop-down menu to select a status to assign to the incident. The default status
is Unresolved.
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Field Description

Assigned
 

Click this drop-down menu to select a group or sta member to assign to the incident.
Use the Find eld at the boom of the Assigned drop-down menu to quickly locate sta
members.
 

Tip:  Wildcards are supported when searching sta members. You can search
strings that include a space by entering %+Space+character, which is
helpful when searching last names. For example, entering %+Space+b returns
all last names starting with the leer b. There is also an implied wildcard when
searching, so entering in the Find eld returns all items containing the leer b.

Product
 

Click this drop-down menu to select a product for the incident.
 

Category
 

Click this drop-down menu to select a category for the incident.
 

Disposition
 

Click this drop-down menu to select a disposition for the incident.
 

Queue
 

Click this drop-down menu to select a queue for the incident.
 

Service Mailbox
 

Click this drop-down menu to select a mailbox to associate with the incident.
 

Customer Entry
 

Enter a default value for the customer thread in this text box.
 

Private Note
 

Click this tab to enter a default value for the notes thread.
 

4. Click Set Custom Field to set custom elds for the incident. The Set Custom Field window opens.

Note:  You must dene custom elds in the Custom Fields editor before you can set a custom eld for
an incident. See Add or Edit a Custom Field.

a. Click the Field drop-down menu to select the custom eld you want to set.
b. Enter the value of the custom eld in the Value eld.
c. Click OK.

The custom eld and its value appear in the Custom Fields grid.
5. To edit the value of a custom eld, click Edit next to the custom eld.
6. To remove the set value of a custom eld, click Delete next to the custom eld.
7. To add any notes associated with the element, click the Notes tab and enter the notes.
8. Click OK.

Related Topics
• Overview of Incidents
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Edit Opportunity Aributes  
After you add an Opportunity element to your ow diagram, you can edit its aributes to dene elds of the
opportunity created by this element.

You can specify the opportunity’s name, status, strategy, stage, assigned sales representative, and territory.
1. Double-click the Opportunity element.

The Opportunity window opens.
2. Enter the name of the element in the Label eld.
3. Enter eld information.

Field Description

*Name
 

Enter the name of the opportunity in this eld.
 
The contact’s email address is appended to the lead name.
 

*Status
 

Click this drop-down menu to assign a status to the opportunity.
 

Strategy
 

Click this drop-down menu to assign the opportunity to a strategy.
 

Stage
 

Click this drop-down menu to assign the opportunity to a stage. The options in this
menu depend on the strategy selected.
 

Assigned
 

Click this drop-down menu to assign the opportunity to a sales representative. Use
the Find eld at the boom of the Assigned drop-down menu to quickly locate sta
members.
 

Tip:  Wildcards are supported when searching sta members. You can search
strings that include a space by entering %+Space+character, which is
helpful when searching last names. For example, entering %+Space+b returns
all last names starting with the leer b. There is also an implied wildcard when
searching, so entering in the Find eld returns all items containing the leer b.

Territory
 

Click this drop-down menu to assign the opportunity to a territory.
 

Summary
 

Enter a summary of the opportunity in this eld.
 

4. Click Set Custom Field to set custom elds for the opportunity. The Set Custom Field window opens.

Note:  You must dene custom elds in the Custom Fields editor before you can set a custom eld for
an opportunity. See Add or Edit a Custom Field.

a. Click the Field drop-down menu to select the custom eld you want to set.
b. Enter the value of the custom eld in the Value eld.
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c. Click OK.
The custom eld and its value appear in the Custom Fields grid.

5. To edit the value of a custom eld, click Edit next to the custom eld.
6. To remove the set value of a custom eld, click Delete next to the custom eld.
7. To add any notes associated with the element, click the Notes tab and enter the notes.
8. Click OK.

Related Topics
• How You Work with Opportunities

Edit Lead Aributes  
After you add a Lead element to your ow diagram, you can edit its aributes to dene elds of the lead created by this
element.

You can specify the status, strategy, stage, assigned sales representative, and territory of the lead.
1. Double-click the Lead element.

The Lead window opens.
2. Enter the name of the element in the Label eld.
3. Enter eld information.

Field Description

*Name
 

Enter the name of the lead in this eld.
 
The contact’s email address is appended to the lead name.
 

*Status
 

Click this drop-down menu to assign a status to the lead. Only statuses with a Lead
status type display. This eld is set to Lead by default.
 

Strategy
 

Click this drop-down menu to assign the lead to a strategy. Only strategies with a stage
assigned the Lead status type display.
 

Stage
 

Click this drop-down menu to assign the lead to a stage. The options in this menu
depend on the strategy selected.
 

Assigned
 

Click this drop-down menu to assign the lead to a sales representative. Use the Find
eld at the boom of the Assigned drop-down menu to quickly locate sta members.
 

Tip:  Wildcards are supported when searching sta members. You can search
strings that include a space by entering %+Space+character, which is
helpful when searching last names. For example, entering %+Space+b returns
all last names starting with the leer b. There is also an implied wildcard when
searching, so entering in the Find eld returns all items containing the leer b.

Territory Click this drop-down menu to assign the lead to a territory.
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Field Description

   

Summary
 

Enter a summary of the lead in this eld.
 

4. Click Set Custom Field to set custom elds for the lead. The Set Custom Field window opens.

Note:  You must dene custom elds in the Custom Fields editor before you can set a custom eld for
a lead. See Add or Edit a Custom Field.

a. Click the Field drop-down menu to select the custom eld you want to set.
b. Enter the value of the custom eld in the Value eld.
c. Click OK.

The custom eld and its value appear in the Custom Fields grid.
5. To edit the value of a custom eld, click Edit next to the custom eld.
6. To remove the set value of a custom eld, click Delete next to the custom eld.
7. To add any notes associated with the element, click the Notes tab and enter the notes.
8. Click OK.

Related Topics
• How You Work with Leads

Edit Add to List Aributes  
After you add an Add to List element to your ow diagram, you can edit its aributes to dene which list the contact is
added to. You can select from predened lists in your system or create a list.

1. Double-click the Add to List element to open the Add to List window.
The Add to List window opens.

2. Enter the name of the element in the Label eld.
3. Select a contact list from the List tab.

a. To search for a contact list, right-click the list and select Search.
b. Enter the list name in the Find eld.

4. To create a contact list, click New Contact List and see Add a Contact List.
5. To add any notes associated with the element, click the Notes tab and enter the notes.
6. Click OK.

Edit Set Field Aributes  
After you add a Set Field element to your ow diagram, you can edit its aributes to specify the value of contact elds.
You can specify a number of dierent eld values, including opt-in status, state, or any contact custom elds dened in
your system.

1. Double-click the Set Field element.
The Set Field window opens.

2. Enter the name of the element in the Label eld.
3. Click the Field drop-down menu and select the contact eld you want to set the value of.
4. To add a new contact custom eld, click Add New Custom Field and see Add or Edit a Custom Field.
5. Enter a value for the contact eld you selected.
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Note:  In addition to seing explicit (absolute) values, you can set null values for text and text
area elds as well as relative values for some eld types. Relative values are dened by adding or
subtracting (or appending or prepending) a value to the previous value of the eld. See Relative Field
Values.

6. To add any notes associated with the element, click the Notes tab and enter the notes.
7. Click OK.

Relative Field Values  
In addition to seing absolute eld values for date, date/time, integer, text, and text area elds, you can set relative
values.

When seing a value for one of these eld types, clicking the Value drop-down menu presents additional options for
adding or subtracting (or appending or prepending) a value to the previous value of the eld. For example, you can
increment the value of an integer eld by 1 or append text to a contact text eld. For date and date/time elds, you can
also set a value relative to the time of action, such as adding one day to the current date and time.

Options for seing relative eld values vary by eld type.

Field Type Value Options

Date
 

Add or subtract a number of days or weeks to or from the previous value or the current date.
 

Date/Time
 

Add or subtract a number of minutes, hours, days, or weeks to or from the previous value or the
current date and time.
 

Integer
 

Add or subtract an integer value to or from the current value.
 

Note:  The resulting value cannot be greater than the maximum value dened for the eld
or less than the minimum. Therefore, the maximum value you can add or subtract is the
maximum value minus the minimum value of the eld. For example, if the eld maximum is
8 and the eld minimum is -8, the maximum value you can add or subtract from the current
value is 16.

Text Field
 

Prepend or append a text value to the current text value.
 

Text Area
 

Prepend or append a text value to the current text value.
 

Edit Execute Object Event Handler Aributes  
You can add contact-related object event handlers to your campaign that can be associated with create and update
operations on contact objects. Object event handlers are added and managed on the process designer in a virtual
container called the process model.

You must add object event handlers from the process designer and then deploy the process model  before you can add
Execute Object Event Handler elements to your campaign.

After you add your object event handlers on the process designer and deploy the process model, you can add an
Execute Object Event Handler element to your ow diagram and then associate it with one your object event handlers to
trigger an action. See Add an Object Event Handler.
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Note:  Only synchronous object event handlers are applicable to campaigns and surveys.

1. Double-click the Execute Object Event Handler element.
The Execute Object Event Handler window opens.
Contact objects must be added on the process designer and then the process model must be deployed for
objects to display on the List tab.

2. Enter the name of the element in the Label eld.
3. Select an object event handler from the List tab.
4. To add notes about the object event handler, click the Notes tab and enter your notes.
5. Click OK.

Edit Transactional Mailing Aributes  
After you add a Transactional Mailing element to your ow diagram, you can edit its aributes to dene which mailing
to send to a contact. In addition, you can choose to send the mailing immediately, at an exact time, or at a certain
interval.

If the mailing is scheduled to be sent at a certain interval, it is stored until the mailer daemon sends it. By default, the
mailer daemon sends scheduled transactional mailings every fteen minutes. If you want the utility to send mailings
more frequently, you must edit the RNMD_EVENT_PROC_INTERVAL conguration seing.

Note:  The Transactional Mailing element simply schedules a mailing to be sent. It does not pause the
processing of the ow until the mailing is sent. Therefore, any elements following this element in the ow
continue to be processed immediately, even if the mailing is scheduled to be sent in the future.

This element can be ltered using segments. If you choose to lter a transactional mailing, you can select whether
contacts who are in or not in the segment will be sent an email.

1. Double-click the Transactional Mailing element.
The Transactional Mailing window opens.

2. Enter the name of the element in the Label eld.
3. Select the mailing you want to send.

a. To search for a mailing, right-click the list and select Search. Then enter the mailing name in the Find
eld.

Note:  In order to send a transactional mailing, it must be in a launched state. If you select a
transactional mailing that has not been launched, it does not send and the system advances to the
next element in your ow diagram.

4. To create a transactional mailing, click New Transactional Mailing. See Create a Transactional Mailing.
5. Click the Schedule tab.
6. Enter eld information.

Field Description

Immediately
 

Select this option to send the email immediately after the action occurs.
 

At exact time
 

Select this option and click the calendar (to the right of the date eld) to select a specic
date and time to send the email.

1662



Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Field Description

 
If this option is selected, a clock icon appears on the Transactional Mailing element to
indicate that a delivery time for the mailing is scheduled.
 

Wait
 

Select this option to send the mailing a specied amount of time after the action is
triggered in the ow. Use the up and down arrows to select the number of units, and
click the drop-down menu to select the interval (minutes, hours, days, or weeks).
 
If this option is selected, a clock icon appears on the Transactional Mailing element to
indicate that a delivery time for the mailing is scheduled.
 

7. Click the Filter tab to select whether or not contacts should be included in the segment to be ltered from the
mailing.
The default is Send This Mailing Only to People in the Following Segment. If you leave the default, only contacts
who meet the criteria in the segment receive the mailing.

8. Select the Filter this Mailing check box.
9. Click the drop-down menu and select whether or not customers in the segment will receive the mailing.

10. Select a segment for the mailing.
11. To add a segment, click New Segment and see Create a Segment.
12. To add any notes associated with the element, click the Notes tab and enter the notes.
13. Click OK.

Edit Transactional Survey Aributes  
After you add a Transactional Survey element to your ow diagram, you can edit its aributes to dene which survey to
send to a contact. In addition, you can choose to send the survey immediately, at an exact time, or at a certain interval.

If the survey is scheduled to be sent at a certain interval, the survey is stored until sent by the mailer daemon. By
default, the mailer daemon is scheduled to send scheduled transactional surveys every fteen minutes.

Note:  The Transactional Survey element simply schedules a survey to be sent. It does not pause the
processing of the ow until the survey is sent. Therefore, any elements following this element in the ow
continue to process immediately, even if the survey is scheduled to be sent in the future.

This element can be ltered using segments. If you choose to lter a transactional survey, you can select whether
contacts who are in or not in the segment are sent an email.

1. Double-click the Transactional Survey element.
The Transactional Survey window opens.

2. Enter the name of the element in the Label eld.
3. Select the survey you want to send.

a. To search for a survey, right-click the list and select Search. Then enter the survey name in the Find eld.
In order to be sent, the transactional survey you select must be in a launched state. If you select a transactional
survey that has not been launched, it is not sent and the system advances to the next element in your ow
diagram.

4. To create a transactional survey, click New Transactional Survey. See Create a Segment.
5. Click the Schedule tab.
6. Enter eld information.
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Field Description

Immediately
 

Select this option to send the survey invitation message immediately after this action
occurs.
 

At exact time
 

Select this option and click the calendar (to the right of the At Exact Time eld) to select
a specic date and time to send the invitation message.
 
If this option is selected, a clock icon appears on the Transactional Survey element to
indicate that a time has been scheduled for this invitation message.
 

Wait
 

Select this option to send the survey invitation message a specied amount of time
after this action is triggered in the ow. Use the up and down arrows to select the
number of units, and click the drop-down menu to select the interval (minutes, hours,
days, or weeks).
 
If this option is selected, a clock icon appears on the Transactional Survey element to
indicate that a time has been scheduled for this invitation message.
 

7. Click the Filter tab and select Filter This Survey to select whether contacts should be included or not included
in the segment to be ltered from the survey.
The default is Send This Survey Only to People in the Following Segment. If you leave the default, only contacts
who meet the criteria in the segment receive the survey.

8. To send the survey to all contacts except those who meet the criteria in the segment, click the drop-down menu
and select Send This Mailing to Everyone Not in the Following Segment.

9. Select a segment for the survey.
10. To add a segment, click New Segment.
11. To add any notes associated with the element, click the Notes tab and enter the notes.
12. Click OK.

Edit External Event Aributes  
External events have been deprecated and may be permanently removed in a future release. Instead, you can use
contact-related object event handlers to trigger actions.

In order to pass contact data to the external event, you must create a template le specifying the data format. For
information about external events or contact-related object event handlers, contact your Oracle account manager.

See Edit Execute Object Event Handler Aributes.

Add a Comment  
The toolbox also provides a Comment artifact that allows you to enter comments in your diagram without impeding
the campaign or survey ow. Comments are added to the canvas in the same way elements are and can be linked to
elements using the Artifact connector type.

1. Drag and drop a Comment artifact from the toolbox onto the canvas.
2. Click the artifact to type your comments.
3. To connect the artifact to an element, click an anchor on the artifact and drag to an anchor on the element.

The anchor is highlighted when the connector is able to link to it.
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Survey Validation  
As you create a ow diagram for your survey, Feedback validates all ow components to ensure all required aributes
have been specied. Although validation occurs in real time as you add and update the components, you can also force
validation manually by clicking Validate on the Designer Home tab.

You can choose to display validation ags by selecting the Validation Results check box on the View tab. This way, valid
components are agged with a green check mark, while those found to be invalid are agged with a red exclamation
point and a small buon you can click to view the validation error. If you aempt to send a survey without rst
addressing its validation errors, the ags automatically display (even if you have not selected the Validation Results
option) along with a message summarizing the errors.

Related Topics
• Advanced Survey Designer View Tab

• Advanced Survey Designer Home Tab

CAN-SPAM Compliance  
Oracle Service Cloud helps you identify CAN-SPAM compliance issues. When creating a mailing or survey with a
message, the system automatically checks that the message contains a physical address, an unsubscribe link, and
honors global opt-in preferences. Remaining requirements must be manually veried by the mailing or survey designer.

Legal denitions and penalties for spam vary among countries. Therefore, it is important to stay abreast of current and
pending legislation in the United States and other countries. There are many sites that you can check to stay current
with the laws and to make sure your site is compliant.

The CAN-SPAM Act of 2003 (CAN-SPAM) requires that organizations adhere to certain rules when sending commercial
emails. Included in the requirements are the following conditions:

• Email does not contain false or misleading header information.

• Email does not use a deceptive subject line.

• Email contains a way for recipients to opt out of all emails, not just specic types.

• Email does not send to contacts that have previously opted out.

• Email must be identied as an advertisement in the subject line.

• Email includes the sender’s physical mailing address, which must display in ASCII text.

• Email that contains adult content is identied as such in the subject line.

• Email does not send to harvested or generated email addresses.

• Email does not send to domains in the Federal Communications Commission (FCC) wireless domain list.

Note:  The checklist is used to gauge your compliance with CAN-SPAM. You should use this checklist in
conjunction with and not as a replacement for legal counsel.

You can check for CAN-SPAM compliance from the Message tab of a mailing, the Invitation Message tab of a survey,
and the Delivery tab of a mailing or survey.

For information about the CAN-SPAM Act, see the  Federal Trade Commission (FTC) website .
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Related Topics
• Check Compliance from the Invitation Message Tab

• Check Compliance from the Message Tab

• Check Compliance from the Delivery Tab

Check Compliance from the Invitation Message Tab  
Testing for CAN-SPAM compliance issues can be accessed from both the Invitation Message and the Delivery tabs in a
survey.

The system automatically checks that the message contains a physical address and an unsubscribe link, and honors
global opt-in preferences. The remaining requirements must be manually veried by the sta member creating the
survey. For best practices related to surveys, see Improving your email marketing.

1. Open a survey and click the Invitation Message tab.
2. Click Test CAN-SPAM under the Content section of Tasks on the HTML editor.

The CAN-SPAM Compliance Report opens.

The report shows whether each system-veried requirement passed or failed. The manually veried
requirements can be selected or cleared based on your manual verications.

Field Description

System Veried
 

This section shows whether the following system-veried requirements passed or
failed.
 

Must Include Physical Address
 

The system automatically veries that a physical address is included in the message.
For this requirement to pass, you must have inserted a physical address clicking Insert
Address on the HTML editor. See Insert a Physical Address. If a text address has not
been inserted using Insert Address, the requirement fails.
 

Must Include a Working Opt-Out
Method
 

The system automatically veries that a global unsubscribe link is included in the
message. The unsubscribe link can be added by clicking Unsubscribe Link in the toolbox
of the HTML editor. When Unsubscribe Link is clicked, a window opens for selecting
the opt-in eld. If Global Opt-In is selected, the requirement passes when CAN-SPAM
compliance is checked.
 

Must Honor Opt-Out Requests
within 10 Days
 

The system automatically veries whether the global opt-in seing is honored by the
survey. By default, the Honor Global Opt-In check box is selected on the Audience tab,
which prevents messages from sending to contacts who have globally opted out of
receiving communications. If this check box is not selected, the requirement fails when
compliance is checked. Since contacts are instantly unsubscribed when they globally opt
out of surveys, any global opt-out requests are automatically met within 10 days.
 

Manually Veried
 

This section lets you select whether the following requirements passed or failed.
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Field Description

Has Candid Subject Line
 

You must manually verify that the message uses a candid subject line. CAN-SPAM
compliance requires that the subject line of an email accurately reects its contents. To
pass this requirement, you should ensure that the subject line is not deceptive to the
email recipient. You can view the subject line in the Preview section.
 

Indicates any Adult Content in
Subject
 

You must manually verify that the subject identies adult content in the message. The
CAN-SPAM Act requires that a message containing adult content must contain the text
“SEXUALLY EXPLICIT” in the subject line of the email. You can view the subject line in
the Preview section.
 

Indicates Any Advertisement in
Subject
 

You must manually verify that the subject identies the message as an advertisement,
when applicable. The CAN-SPAM Act requires that the message contains clear and
conspicuous notice that the message is an advertisement or solicitation. To pass this
requirement, you should ensure that the subject line accurately reects the message
content. You can view the subject line in the Preview section.
 

Has Accurate From and Reply-To
Headers
 

You must manually verify that the From and Reply-To headers contain accurate
information. CAN-SPAM compliance requires that the From and Reply-To headers and
routing information, including the originating name and email address, must accurately
identify your organization. You can view the From and Reply-To headers and the return
path in the Preview section.
 

Does Not Send to Harvested or
Generated Addresses
 

You must manually verify that you are not sending the message to harvested or
generated addresses. Harvested email addresses are gathered from websites or web
services that have published a notice prohibiting the transfer of email addresses for the
purpose of sending email. Generated email addresses are formed by using a “dictionary
aack,” by combining names, leers, or numbers into multiple permutations.
 

Does Not Send to Domains in FCC
Wireless List
 

You must manually verify that you are not sending the message to email addresses
that contain domains in the FCC wireless list. The CAN-SPAM Act prevents the
sending of messages to wireless devices, such as mobile phones. The FCC publishes a 
downloadable list of domain names used by cellular companies .
 

Overall Compliance
 

This section indicates whether the email is entirely CAN-SPAM compliant. If any of the
compliance criteria in this table fails, overall compliance fails.
 

Preview
 

This section lets you preview the following parts of a message.
 

Preview Message
 

Click this text to preview the message.
 

Subject
 

Displays the subject of the message.
 

1667

http://www.fcc.gov/cgb/policy/DomainNameDownload.html
http://www.fcc.gov/cgb/policy/DomainNameDownload.html


Oracle Service Cloud
Using Service Cloud

Chapter 10
Outreach and Feedback

Field Description

Return-Path
 

Displays the mailbox address the message is being sent from.
 

From
 

Displays the From address of the message.
 

Reply-To
 

Displays the Reply-To address of the message.
 

3. Select the check box next to the manually veried items that you have veried.
4. Click OK.

Check Compliance from the Delivery Tab  
You can check for CAN-SPAM compliance issues from the Delivery tab of a mailing or survey. You can also test CAN-
SPAM compliance from the Message tab of a mailing or the Invitation Message tab of a survey.

The system automatically checks that the message contains a physical address and an unsubscribe link, and honors
global opt-in preferences. The remaining requirements must be manually veried by the sta member creating the
mailing or survey.

1. Open a mailing or survey and click the Delivery tab.
2. Click Test CAN-SPAM in the Delivery Checklist section.

The CAN-SPAM Compliance Report opens.

The report shows whether each system-veried requirement passed or failed. The manually veried
requirements can be selected or cleared based on your manual verications.

Field Description

System Veried
 

This section shows whether the following system-veried requirements passed or
failed.
 

Must Include Physical Address
 

The system automatically veries that a physical address is included in the message.
For this requirement to pass, you must have inserted a physical address clicking Insert
Address on the HTML editor. See Insert a Physical Address. If a text address has not
been inserted using Insert Address, the requirement fails.
 

Must Include a Working Opt-Out
Method
 

The system automatically veries that a global unsubscribe link is included in the
message. The unsubscribe link can be added by clicking Unsubscribe Link in the toolbox
of the HTML editor. When Unsubscribe Link is clicked, a window opens for selecting
the opt-in eld. If Global Opt-In is selected, the requirement passes when CAN-SPAM
compliance is checked.
 

Must Honor Opt-Out Requests
within 10 Days
 

The system automatically veries whether the global opt-in seing is honored by the
survey. By default, the Honor Global Opt-In check box is selected on the Audience tab,
which prevents messages from sending to contacts who have globally opted out of
receiving communications. If this check box is not selected, the requirement fails when
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Field Description

compliance is checked. Since contacts are instantly unsubscribed when they globally opt
out of surveys, any global opt-out requests are automatically met within 10 days.
 

Manually Veried
 

This section lets you select whether the following requirements passed or failed.
 

Has Candid Subject Line
 

You must manually verify that the message uses a candid subject line. CAN-SPAM
compliance requires that the subject line of an email accurately reects its contents. To
pass this requirement, you should ensure that the subject line is not deceptive to the
email recipient. You can view the subject line in the Preview section.
 

Indicates any Adult Content in
Subject
 

You must manually verify that the subject identies adult content in the message. The
CAN-SPAM Act requires that a message containing adult content must contain the text
“SEXUALLY EXPLICIT” in the subject line of the email. You can view the subject line in
the Preview section.
 

Indicates Any Advertisement in
Subject
 

You must manually verify that the subject identies the message as an advertisement,
when applicable. The CAN-SPAM Act requires that the message contains clear and
conspicuous notice that the message is an advertisement or solicitation. To pass this
requirement, you should ensure that the subject line accurately reects the message
content. You can view the subject line in the Preview section.
 

Has Accurate From and Reply-To
Headers
 

You must manually verify that the From and Reply-To headers contain accurate
information. CAN-SPAM compliance requires that the From and Reply-To headers and
routing information, including the originating name and email address, must accurately
identify your organization. You can view the From and Reply-To headers and the return
path in the Preview section.
 

Does Not Send to Harvested or
Generated Addresses
 

You must manually verify that you are not sending the message to harvested or
generated addresses. Harvested email addresses are gathered from websites or web
services that have published a notice prohibiting the transfer of email addresses for the
purpose of sending email. Generated email addresses are formed by using a “dictionary
aack,” by combining names, leers, or numbers into multiple permutations.
 

Does Not Send to Domains in FCC
Wireless List
 

You must manually verify that you are not sending the message to email addresses
that contain domains in the FCC wireless list. The CAN-SPAM Act prevents the
sending of messages to wireless devices, such as mobile phones. The FCC publishes a 
downloadable list of domain names used by cellular companies .
 

Overall Compliance
 

This section indicates whether the email is entirely CAN-SPAM compliant. If any of the
compliance criteria in this table fails, overall compliance fails.
 

Preview This section lets you preview the following parts of a message.
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Field Description

   

Preview Message
 

Click this text to preview the message.
 

Subject
 

Displays the subject of the message.
 

Return-Path
 

Displays the mailbox address the message is being sent from.
 

From
 

Displays the From address of the message.
 

Reply-To
 

Displays the Reply-To address of the message.
 

3. To view a read-only copy of the results from the last time CAN-SPAM compliance was tested, click Details next
to CAN-SPAM Compliance on the Delivery tab.

Survey Session Recovery  
When a contact loads a survey in a web browser, a cookie is placed on the contact’s computer and updated to track
which survey pages have been submied.

If a contact aempts to access a survey that the contact has abandoned, the system detects this from information in the
survey cookie and then loads the rst page in the survey page sequence that has not yet been submied. This ensures
that the contact does not have to answer all questions again from the rst page of the survey. This cookie is separate
from the session cookie placed when a contact logs in to the customer portal and does not aect login status.

Note:  By default, the survey cookie does not expire and is cleared only when the survey is completed.
Therefore, contacts are not able to start over or access previously submied pages unless the cookie is rst
cleared from their browser. You can disable the survey cookie or dene an expiration interval by editing
the RNM_RESUME_SURVEY_COOKIE_EXP conguration seing (Outreach and Feedback/General/
Miscellaneous). However, upon clearing the cookie and reloading the survey, all questions revert to a blank
state. At no time can contacts see answers that they previously submied.

Customize Feedback Conguration Seings  
Feedback provides many options that can be activated by editing conguration seings. These seings are used to set
cookie expiration times, dene default values for Serve Web Page element properties, and specify whether documents
can be edited after having been sent in a survey.

You can also dene the subject line of Forward to Friend emails and specify a default URL to load in cases where a blank
page would have been displayed.

1. Expand Site Conguration, and then double-click Conguration Seings.
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The Search window opens, where you can lter your search results.
2. Clear the Select All check box and then select the Outreach and Feedback check box.
3. To search for a specic conguration seing in the Outreach and Feedback folder, enter the seing name in the

Key eld.
You can search part of a conguration seing name by appending a wildcard (either an asterisk or a percentage
sign) to the end of your search term.

4. Click Search.
The Conguration Seings editor displays the seings in the Outreach and Feedback folder that match your
search criteria.

Tip:  To display conguration seings in alphabetical order, click in the Key column header.

5. Expand the folders under Outreach and Feedback/General.
6. Customize the seings under the specic Campaigns and Miscellaneous folders.

For information about a seing, see the description that appears on the Conguration Seings editor. For
complete details about the Conguration Seings editor, including searching, editing, and creating new
conguration seings, see Edit a Conguration Seing.

Related Topics
• Overview of Site Conguration

Best Practices for Mailings, Surveys, and Campaigns  
There are a number of methods or techniques that are generally found to be superior to those achieved by other means
or that have become a standard mode of operation. Best practices as they apply to Outreach and Feedback as well as
email management are listed here.

• Best Practices for Sending Email

• Best Practices for Using Branded Email Domains

• Best Practices for Creating Eective Survey Reminders

• Best Practices for Writing Eective Questions

• Best Practices for Mobile Surveys

• Best Practices for Using Matrix Questions in Mobile Surveys

• Best Practices for Topic Monitoring

Ensuring that contacts read your message
Because most mail clients list new messages by From address and subject, the contents of these elds are critical to
having your message read. Rene your message subject to be concise yet informative and make sure it clearly states
your purpose and any special conditions of your oer. If it isn’t clear who you are or what you want, your message can
be easily passed over.

Improving your email marketing
In addition to anti-spam legislation, many other external factors can negatively impact the eciency and success of
your surveys. As an Outreach and Feedback user, it is important that you follow industry-accepted best practices to
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protect your reputation, optimize your audience, and produce well-formed content. While these best practices do not
guarantee that your emails will always be accepted, they can improve the chances that your messages are delivered to
the intended recipients with minimal interference from content monitors and lters. Since these practices are focused
on improving the quality of your contact data as well as your messages, your survey conversion rates will most likely
improve as well.

Standard element placement when using next and back buons
When you use next and back buons with standard elements, we recommend adding those elements to the end rather
than to the middle of your ow. For example, suppose you add an Incident element to the second page of a survey,
and then you add next and back buons on subsequent pages. This scenario could cause two incidents to be created
if respondents go back to the rst page, because when they are ready to move forward, clicking the next buon will
resubmit the incident. Therefore, to avoid the possibility of triggering duplicate actions, we recommend adding standard
elements (such as an Incident element) to the end of your surveys.

Send proofs to key sta
When sending proofs, consider adding key members of your customer support, sales, and marketing teams. Sharing a
sample of each mailing or survey can help ensure that all contact “touch points” (groups in your organization that work
directly with customers) are aware of the messages being communicated to your customers. Providing a consistent
message across all channels is key to providing a world-class customer experience.

Scheduling mailings and surveys for market testing
Market testing your mailings and surveys works best when you schedule the test messages at the same time rather
than launching them a few minutes apart. By scheduling test messages at the same time, the database and servers
have to process data only once instead of multiple times.
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11  Social Experience

Overview of Social Experience  
Oracle RightNow Social Experience (Social Experience) is your organization’s gateway to providing exceptional service
on the social cloud.

A set of complementary features, each representing a dierent, powerful way of interacting with customers using social
media, comprise Oracle RightNow Social Experience. While each component serves a distinct purpose, they can be used
together to create a wide-ranging social web presence. By engaging with your customers using leading social channels
or providing a targeted social channel of your own, you can foster dynamic customer relationships, deliver powerful
support oerings, and build brand loyalty.

To make the most eective use of social media, be sure to review each feature and consider its benets to your service
initiatives. Together, the major components summarized here provide a comprehensive solution for organizations
looking to expand and solidify their social media presence.

Communities—The Communities feature of Oracle RightNow Social Experience is not available to new Oracle RightNow
Cloud Service customers beginning with the August 2015 release. If you are an existing customer using Social
Experience communities, see  Communities in the May 2015 documentation .

Channels—An extensive variety of methods by which your sta can communicate with your customers. Channels refer
to all of the available sources of social messaging, incoming incidents, and outgoing responses that are monitored and
processed by Oracle RightNow Cloud Service. In addition to traditional sources such as Service and Outreach mailboxes,
chat, and the Ask a Question page, channels support leading social media such as Facebook, Twier, YouTube, and RSS
feeds.

Social Monitor—With Oracle RightNow Social Monitor Cloud Service (Social Monitor), you can monitor and participate in
conversations on the social web. You can also interact with your customers by searching leading social media services,
create incidents in Oracle RightNow Cloud Service, and include social media in your Oracle RightNow Outreach Cloud
Service and Oracle RightNow Feedback Cloud Service messages. You can improve customer experiences by identifying
trends in customer issues and opinions, and proactively communicate with customers through social channels using
incidents. See Overview of Social Monitor.

Self Service for Facebook—Oracle RightNow Self Service Cloud Service for Facebook is a social web solution you can use
to embed a set of Oracle Service Cloud service features directly on your organization’s Facebook page. As a result, your
organization can deliver a consistent experience to customers and fans on Facebook while maintaining a unied view of
customer interactions across channels.

Related Topics
• Overview of Channels

• Overview of Social Monitor

• Overview of Self Service for Facebook
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Channels  

Overview of Channels  
Channels are the forms of communication by which your sta members listen and respond to your customers.

In Oracle Service Cloud, channels refer to all of the available sources of social messaging, incoming incidents, and
outgoing responses that are monitored and processed by your site. Channels are helpful for routing new incidents to the
agent desktop using the Incident.Channel eld as a rule condition in business rules. See Overview of Business Rules.

Oracle Service Cloud supports a broad range of channels that fall into two main categories:

• Standard channels—Traditional channels through which incidents are created and responded to. These include
CSS Email (email submied to a Service mailbox), MA Email (email submied to an Outreach mailbox), Phone,
Fax, Post, CSS Web (Ask a Question), MA Web (created by a campaign or advanced survey), Chat, and Email
(responses sent to customers by email). Standard channels are most commonly used to reference incident
thread sources that are congured in Oracle Service Cloud and Oracle RightNow Outreach Cloud Service, such
as mailboxes, chat sessions, and campaign ow actions. See Incident Thread.

• Social channels—Channels used by the Social Monitor Cloud Service (also known as the social monitor) to
search the social web for comments, opinions, and issues related to your organization and its products. These
channels include a variety of social media such as Facebook, Twier, YouTube, and RSS feeds. Social channels
are most commonly used when performing cloud searches and to indicate the sources of incident thread
entries. See Social Channels.

You can edit the name of each channel to suit your business needs. However, the default names are appropriate for
most implementations.

Related Topics
• Edit a Channel Name

Social Channels  
Social channels are used with the social monitor to search the social web for posts and comments related to your
organization and its products.

These channels include a variety of social media such as Facebook, Twier, YouTube, and RSS feeds. While many social
channels feature default channels that can be used to monitor public feeds, Oracle Service Cloud supports additional
functions based on the services each social media source provides.

• Custom channels are used to dene and extend the range of sources that your organization can monitor. For
example, if your organization maintains a Facebook page, you can create a custom channel to focus your cloud
searches on the posts and comments on that page. Custom channels can be created for Facebook and RSS
feeds using the Channels editor.

• Channel accounts enable your sta members to monitor and respond to incidents from your organization’s
social media accounts. A channel account is a shared credential that allows designated sta accounts
to perform service functions through a single social media account that requires login and password
authentication. In this way, you can provide agents with the access they need to assist customers while
maintaining the condentiality of your social media account logins. Because channel accounts can be
associated with specic sta members and groups, they can be used to govern access to dierent custom
channels from the same social media site. This is helpful if, for example, your product teams maintain separate
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Twier accounts for dierent purposes. Channel accounts can be created for Facebook and Twier using the
Channel Accounts editor.

• Channel types can be used with Facebook, Twier, and YouTube to associate social monitor incidents with
contacts based on their social media user names. See How You Store Social Media User Names.

Note:  Because most social media services are external to Oracle Service Cloud, it is important to consider
potential security risks and take the appropriate precautions associated with third-party login information,
customer data, and application code. See Overview of Security-Related Conguration Seings.

Related Topics
• How You Add Facebook Channels

• How You Add Twier Channel Accounts

• How You Use the YouTube Channel

• Add a Custom RSS Channel

Edit a Channel Name  
You can edit the name of any channel to suit your specic business needs or preferences.

To edit the name of a social channel the social monitor must be enabled. To enable the social monitor, contact your
Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channels.

The Channels tree displays on the left side of the content pane listing all of the channel types.
3. Click the down arrow (Expand All) at the top of the Channels tree to display all channels grouped by channel

type, then select the channel you want to edit.
The channel’s seings display on the Channels editor on the right side of the content pane.

4. Enter a new name for the channel in the Name eld.
5. Click Save.

Related Topics
• Overview of Channels

How You Add Facebook Channels  
You can add custom Facebook channels to focus your social cloud searches on your organization’s Facebook pages.

Facebook is a social media network on which users can post personal prole information, submit status updates,
exchange messages, and participate in groups and events. Fan pages are public web pages on Facebook that you can
use to share your organization and its products and services. Facebook does not support searches of its public feed.
You can only search Facebook fan pages. By adding a custom Facebook channel, you can perform cloud searches of the
posts on your organization’s Facebook fan page. See Add a Cloud Search.

If you want your sta to be able to interact with customers on Facebook, you can also dene a channel account to
permit specic sta members to monitor your Facebook pages and send responses. When agents reply to Facebook
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posts, their replies appear to come from the fan page and not from individual personas. See Respond to a Facebook
Post.

Note:  Because each Facebook fan page is associated with a specic Facebook account, each custom
Facebook channel can have only one channel account per fan page. For this reason, Facebook account
credentials are congured on the Channels editor, and the Channel Accounts editor is used to specify which
sta accounts have access.

You can also congure Oracle Service Cloud to store Facebook user IDs in contact records. See How You Store Social
Media User Names.

Related Topics
• Social Channels

• Add a Custom Facebook Channel

• Provide Sta Access to a Facebook Channel

• Add a Cloud Search

• Respond to a Facebook Post

Add a Custom Facebook Channel  
Congure Facebook account credentials for one of your organization’s Facebook fan pages so that it can be monitored
with cloud searches.

The social monitor must be enabled in order to use custom channels with your application. To enable the social monitor,
contact your Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channels.

The Channels tree displays on the left side of the content pane listing all of the channel types.
3. Click Facebook in the Channels tree.
4. Click New.

The Channels editor is displayed on the content pane.
5. Enter a name for the custom channel in the Name eld.
6. Click Grant Access.

If you are not already logged in to Facebook, the Facebook Login window displays. Enter the credentials for the
Facebook account associated with the page you want to monitor, then click Log In.

Note:  If you are using a Facebook account other than the one used to administer the page, the
person who administers the Facebook page must add your account as an admin for the page through
Facebook.

The prole name and image of the authenticated account is displayed on the Channels editor and a message
informs you that you have been granted access.

7. Click OK on the granted access message to close it.
8. Enter eld information.

Field Description

Fan Page
 

Click to select the fan page that you want to monitor. Available options include all pages
administered by the Facebook account you are using. To enter a dierent fan page ID,
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Field Description

 select Advanced: Custom Fan Page ID. If you do not want to indicate a specic fan
page at this time, select None.
 
When you select an existing page, its fan page ID is automatically populated in the Fan
Page ID eld.
 

*Fan Page ID
 

Enter the Facebook page ID.
 
This eld is editable only when you select Advanced: Custom Fan Page ID from the Fan
Page menu. To manually obtain a Facebook page ID, navigate to your organization’s fan
page in Facebook. The Facebook page ID is the 15-digit number visible near the end of
the URL in the browser address bar.
 

Private Messaging Permissions These options dene how private messages received by this account will be processed
by Oracle Service Cloud.

Monitor
 

Select to allow sta members to monitor the account private messages. Private
messages will be reected on the Social Monitor dashboard and will appear in search
results.
 

Respond
 

Select to allow sta members to send incident responses to a customer’s private
messages using the channel account. Responses to a customer’s private message will
default to a private message response, although the agent can specically mark it as a
public message. Private message conversations must be initiated by a customer.
 

Automatically Create Incident
 

Select to automatically create new incidents from all private messages received by the
channel account.
 
This check box is available only when the Monitor option is selected.
 

Channel Options These options are used to manage monitoring of the channel.
 

Disabled for Social Monitor
 

Select to disable the channel, which will prevent sta members from using it.
 

Enable Subscriptions
 

Select to make the channel available for monitoring on a subscription basis. See Add a
Cloud Search.
 

Interface Label
 

This section contains the names of all available interfaces, the languages they are
implemented in, and the language-specic label of the channel. See Overview of
Multiple Interfaces.
 
By default, the Label eld is populated with the name you typed in the Name eld. When
using multiple-language interfaces, you must enter the label in the Label eld in the
language of the interface.
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Field Description

 

9. Click Save.

Note:  After the channel is saved and has been used to perform cloud searches, the Search Manager
buon on the Channels editor ribbon will become active. This function provides access to a utility for
managing cloud searches by channel. See Manage Cloud Searches for a Channel.

Related Topics
• Social Channels

• Provide Sta Access to a Facebook Channel

Provide Sta Access to a Facebook Channel  
If you want your sta to be able to interact with customers on Facebook, you must congure a channel account to
permit specic sta members to monitor and send responses on a custom Facebook channel.

The social monitor must be enabled in order to use channel accounts with your application. To enable the social
monitor, contact your Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channel Accounts.

The Channel Accounts tree displays on the content pane.
3. Click the arrow next to a Facebook custom channel to expand it and then click its contained channel account.

The Channel Accounts editor is displayed
4. Enter eld information.

Field Description

*Name Enter a name for the Facebook channel account in this eld. The default value is the
Facebook custom channel name.

Accounts Select a group check box to associate all sta members in the group with the channel
account or expand the group to select sta members individually. To select all groups,
 select the Select All check box.
You can also assign a sta member to a channel account from the Sta Accounts editor.
See Grant Channel Account Access to a Sta Account.
 

5. Click Save.

Related Topics
• Social Channels

• Add a Custom Facebook Channel
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How You Add Twier Channel Accounts  
A Twier channel account lets your agents monitor and respond to Twier messages using Oracle Service Cloud.

Twier is a popular social media site on which users can post short messages (tweets) and follow similar posts from
other users. Oracle Service Cloud provides a default Twier channel that you can access through the social monitor to
perform searches of the Twier public feed. In order to monitor the Twier public feed, you must rst create a Twier
channel account and then use it to enable the public Twier feed for social monitoring.

Channel accounts also let you monitor and automatically create incidents from private messages sent to your
organization’s Twier accounts.

Access to Twier channel accounts can be restricted to specic groups and accounts. For instance, your product teams
may maintain separate Twier accounts for dierent purposes. Channel accounts allow you to extend authentication to
these dierent channels for dierent sta members or groups.

Tip:  When you add a channel account, your agents can respond to Twier messages publicly or privately
from the agent desktop. However, because handling customer issues publicly can be problematic, you should
always encourage your customers to communicate privately when resolving support issues through the
Twier channel. See How You Respond to Twier Posts.

You can also congure Oracle Service Cloud to store Twier user names in contact records. See How You Store Social
Media User Names.

Related Topics
• Social Channels

• Add a Channel Account for Twier

• Enable the Public Twier Channel for Social Monitoring

• Add a Cloud Search

Add a Channel Account for Twier  
If you want your sta to monitor and respond to public or private Twier messages using one of your organization’s
Twier accounts, you must add a Twier channel account.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channel Accounts.

The Channel Accounts tree displays on the content pane.
3. Click Twier in the Channel Accounts tree, then click New.

The Channels Accounts editor is displayed on the content pane.
4. Enter eld information.

Field Description

*Name
 

Enter a name for the Twier channel account in this eld.
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@Mention Monitoring Enabled
 

Select to allow sta members to perform cloud searches for mentions of this Twier
channel account in the Twier public stream. See Add a Cloud Search.
 

Private Message Permissions The following permissions dene how private messages received by this account will be
processed by Oracle Service Cloud.
 
A Twier account can receive private (direct) messages from anyone when the Receive
Direct Messages From Anyone seing in Twier security and privacy seings is
selected. Also, a Twier account can reply to anyone that sends a private message. See
Twier.
 

Monitor
 

Select to allow sta members to monitor the account private messages. Private
message search results will be displayed in the social monitor when you click Private
Messages. See Monitor Private Messages from Twier.
 

Respond
 

Select to allow sta members to send incident responses to private messages using this
channel account. See How You Respond to Twier Posts.
 

Automatically Create Incident
 

Select to automatically create new incidents from all private messages received by the
channel account.
 
This option is available only when the Monitor option is selected.
 

Accounts
 

Select a group check box to associate all sta members in the group with the channel
account or expand the group to select sta members individually. To select all groups,
 select the Select All check box.
 
You can also assign a sta member to a channel account from the Sta Accounts editor.
See Grant Channel Account Access to a Sta Account.
 

5. Click Grant Access.
The Twier Authorization window displays.

6. Enter the credentials for the Twier account, then click Authorize App.
A message informs you that you have been granted access.

7. Click OK on the granted access message to close it.
8. Click Save.

Related Topics
• Social Channels

• Enable the Public Twier Channel for Social Monitoring
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Enable the Public Twier Channel for Social Monitoring  
In order to monitor and respond to messages on the public Twier feed, use the channel editor to associate a Twier
channel account and congure channel options.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channels.

The Channels tree displays on the left side of the content pane listing all of the channel types.
3. Double-click Twier in the Channels tree, then select the Twier channel.

The Twier channel is displayed in the Channels editor on the content pane.
4. Enter eld information.

Field Description

*Name
 

Enter a name for the channel in this eld.
 
When you move to another eld, the Label eld in the Interface Label section is
populated with the name you entered in the Name eld.
 

Channel Account
 

Click to select the channel account you want to use to authenticate cloud searches.
 
You must select a channel account in order for the public Twier channel to be available
for monitoring.
 

Disabled for Social Monitor
 

Select to disable the channel, which will prevent sta members from using it.
 

Interface Label
 

This section contains the names of all available interfaces, the languages they are
implemented in, and the language-specic label of the channel. See Overview of
Multiple Interfaces.
 
By default, the Label eld is populated with the name you typed in the Name eld. When
using multiple-language interfaces, you must enter the label in the Label eld in the
language of the interface.
 

Note:  Because Twier channels do not support social monitor subscriptions, the Enable
Subscriptions check box is inactive for this channel.

5. Click Save.

Related Topics
• How You Add Twier Channel Accounts

• How You Monitor the Social Cloud

• How You Respond Through Social Channels
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Add a Custom RSS Channel  
In addition to monitoring leading social media services, you can dene custom RSS channels to monitor content posted
in publicly accessible RSS feeds.

Oracle Service Cloud supports feeds that conform to the RSS 2.0, ATOM, and RSS (RDF) 1.0/.90 standards. With
custom RSS channels, sta members can monitor RSS feeds (such as news headlines) for content. For example, if your
organization releases a new product or service, you can search for your product or service using an RSS channel to see
what the media are reporting. Because you are generally searching news headlines with RSS channels, it is not possible
to respond to RSS feeds.

Note:  RSS channels do not support channel accounts because agents cannot respond to customers through
RSS.

1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channels.

The Channels tree displays on the left side of the content pane listing all of the channel types.
3. Click RSS in the Channels tree.
4. Click New.

The Channels editor is displayed on the content pane.
5. Enter eld information.

Field Description

*Name
 

Enter a name for the custom channel in this eld.
 
When you move to another eld, the Label eld in the Interface Label section is
populated with the name you typed in the Name eld.
 

*URL
 

Enter the URL of the RSS feed. The URL must begin with hp:// or hps://.
 
Oracle Service Cloud supports RSS 2.0, ATOM, and RSS (RDF) 1.0/.90 feeds.
 

Validate
 

Click to verify that the URL and format of the feed are valid. A message will appear next
to the buon indicating that the feed is valid or invalid.
 

Disabled for Social Monitor
 

Select to disable the channel, which will prevent sta members from using it.
 

Enable Subscriptions
 

Select to make the channel available for monitoring on a subscription basis. See Add a
Cloud Search.
 

Interface Label
 

This section contains the names of all available interfaces, the languages they are
implemented in, and the language-specic label of the channel. See Overview of
Multiple Interfaces.
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Field Description

 
When using multiple-language interfaces, you must enter the label in the Label eld in
the language of the interface.
 

6. Click Save.

Related Topics
• Overview of Channels

• How You Monitor the Social Cloud

How You Use the YouTube Channel  
Oracle Service Cloud provides a default YouTube channel that you can access through the social monitor to perform
searches of YouTube’s public feed.

YouTube is a popular social media site on which users can view and share videos. Because agents cannot respond to
customers through YouTube, the default YouTube channel provided by Oracle Service Cloud does not support custom
channels or channel accounts The channel is provided strictly for monitoring purposes so that you can see what
YouTube users are saying about your products or services.

You can also congure Oracle Service Cloud to store YouTube user names in contact records. See How You Store Social
Media User Names.

Related Topics
• How You Monitor the Social Cloud

• Add a Cloud Search

Grant Channel Account Access to a Sta Account  
In order to respond to incidents created through a social channel, agents must rst be granted access to a channel
account congured for that channel.

While you can grant channel account access to groups and agents through the Channel Accounts editor, you can also
provide access to specic agents by editing their sta accounts.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Sta Accounts by Prole.

The report opens on the content pane.
3. Double-click the sta account that you want to grant channel account access to.

The Sta Accounts editor opens.
4. Click Channels.

The Account Channels editor opens. The Channels section lists the default and custom social channels
congured in Oracle Service Cloud and the number of associated channel accounts for which the sta account
has been granted access.
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5. Click the channel that you want to provide access for.
The Channel Accounts section displays any channel accounts that are currently associated with the sta
account for the selected channel.

6. Click Add.
The Channel Accounts window opens, displaying all of the channel accounts associated with the channel you
selected that are not restricted from or already associated to the sta account.

7. Double-click the channel account you want to add.
The Channel Accounts window closes and the channel is added to the Channel Accounts section on the
Accounts Channel editor.

8. To change the default channel account, select the radio buon in the Default column of the desired default
channel account.

Note:  The default channel account is the channel account that sta members will use when
responding to incidents. However, if they have been granted access to more than one channel account,
they will have the option to select another channel account at that time. See How You Respond
Through Social Channels.

9. Click Save.

Related Topics
• Social Channels

• Overview of Sta Management

How You Store Social Media User Names  
When monitoring certain channel types, Oracle Service Cloud can store your customers’ social media identier in their
contact records which lets you associate incoming social monitor incidents with contacts based on their social media
accounts and helps agents identify where posts originate.

When an incident is created through Facebook, Twier, or YouTube, Oracle Service Cloud searches all contacts for
an instance of the associated social media identier. If a matching identier is located, the incident is automatically
associated with the contact. If no matching identier is found, a new contact containing the identier is created for the
incident.

• When an incident is created through a Facebook channel, Oracle Service Cloud populates the Channel
Usernames eld in the contact record with the post author’s Facebook user ID.

• When an incident is created through Twier or YouTube, the Channel Usernames eld is populated with the
user name from the channel.

In addition to this automated process, contacts and sta members can be permied to add and edit user names for
each channel type, based on the visibility seings on the Channel Types editor and the conguration of the customer
portal and agent workspace.

• Contacts can add, edit, and view their Facebook, Twier, and YouTube user names through the ChannelAllInput
and ChannelAllDisplay widgets on the customer portal. See Customer Portal Widgets.

• Sta members can add and edit Facebook, Twier, and YouTube user names for contacts from a custom
contact workspace. Before sta members can add and edit social media user names, the Channel Usernames
eld must be added to the contact workspace. See Overview of Workspaces.
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Note:  Channel types are not interface specic and cannot be deleted.

Related Topics
• Social Channels

• Edit a Channel Type

• Add or Edit a Social Media User Name for a Contact

Edit a Channel Type  
You can permit sta members and contacts to add and edit social media user names based on the channel type
visibility seings.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Customizable Menus.

The Customizable Menus tree opens on the content pane.
3. Click the System Menus drop-down arrow, then click Channel Types.

The Channel Types editor is displayed.
4. To rename a channel type:

a. Click it in the Label column.
The Interface Visibility section displays, showing the names of all available interfaces, the languages
they are implemented in, and the language-specic label of the channel.

b. Enter the new name for the channel type. When you move to another eld, the Label eld in the Interface
Visibility section is populated with the name you typed.

Note:  When using multiple-language interfaces, enter the label in the Label eld in the
language of the interface.

5. To remove channel type visibility for sta members and contacts, clear the Contact Visible check box next to
the applicable channel type.
This removes sta member visibility for the channel type in the Channel Usernames eld on custom contact
workspaces. In addition, visibility is removed from the applicable widget on the customer portal.

6. To change the display sequence of channel types on the custom contact workspace and the customer portal,
click the up or down arrow next to the Contact Visible column.

7. Click Save.

Add or Edit a Social Media User Name for a Contact  
Agents can add, edit, and remove social media user names for a contact.

• The Channel Usernames eld must have been added to the custom contact workspace being used. See Edit a
Workspace.

• The Contact Visible check box must be selected for the channel type. See Edit a Channel Type.

1. While editing a contact record, click Add or Edit in the Channel Usernames eld.
The Channel Types Usernames window opens.

2. To add a social media user name:
a. Click Add Username.
b. Click Channel Type and select Facebook, Twier, or YouTube.
c. Enter the contact’s user name in the Username column.
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3. To edit a social media user name, enter changes in the Username column.

CAUTION:  Changing the social media user name may aect the ability of the system to accurately
track open conversations with the user.

4. To remove a social media user name, click Remove in the Action column.
5. Click OK.
6. Click Save.

Related Topics
• Overview of Workspaces

• Customer Portal Widgets

Manage Cloud Searches for a Channel  
The Cloud Search Manager utility on the Channels editor lets you disable searches that were entered incorrectly, or are
no longer needed, and to view and manage the list of agents who have selected each search as a favorite.

The Search Manager buon is active only when a cloud search has been added to the channel using the social monitor.
1. Click Conguration on the navigation pane.
2. Expand Service, and then double-click Channels.

The Channels tree displays on the left side of the content pane listing all of the channel types.
3. Click a channel to display it on the Channels editor.
4. Click Search Manager.

The Cloud Searches section displays a list of cloud searches that have been added for the channel, including
the search text and the number of instances that each search has been set as a favorite.

5. Select a cloud search from the list to populate the Favorites panel with a list of all agents who have set that
search as a favorite.

6. To remove the search from an agent’s list of favorites, click Remove next to the agent name.
7. To remove the search from all favorite lists, click Remove All.
8. To hide a cloud search from all standard reports and remove it from all agent favorite lists, select Disabled next

to the search.

CAUTION:  Removing cloud searches from all agent favorites and disabling a search cannot be
undone. If you did either of these actions in error, close the Channels editor without saving your
changes.

9. Click Save.

Related Topics
• Social Channels
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Social Monitor  

Overview of Social Monitor  
To extend great customer experiences across social media channels and protect your organization’s valued reputation, it
is essential to employ a social media strategy that includes monitoring, and sometimes participating in, conversations in
the social cloud.

With a growing portion of the world’s population now depending on social media like Twier and Facebook for
communicating with friends and colleagues, it has become crucial for organizations to monitor the dialogue about their
products and services that is taking place on the social web. The power of customer perspectives multiplied through
social channels can have a dramatic impact, be it harmful or helpful, on business revenue.

Using Oracle RightNow Social Monitor Cloud Service (also known as the social monitor), you can interact with your
customers by searching social media services, create incidents in Oracle Service Cloud, and include social media in your
Oracle RightNow Outreach Cloud Service and Oracle RightNow Feedback Cloud Service messages. You can improve
customer experiences by identifying trends in customer issues and opinions, and proactively communicate with
customers through social channels using incidents. See How You Respond Through Social Channels.

Note:  The social media services described here are not provided by or aliated with Oracle. To obtain support
or information about terms and conditions for any of the services mentioned, contact the service provider.

Congure Access to the Social Monitor  
Before you can monitor the social cloud to search for information related to your organization, you need to congure
your application to provide access to the tools used to manage cloud searches and respond to customer posts.

Social monitoring must be enabled for your site. To enable social monitoring, contact your Oracle account manager.
1. Add the Social Monitor Component to a Navigation Set.
2. Add Social Monitor Permission to a Prole.
3. Add or Edit a Sta Account.

Add the Social Monitor Component to a Navigation Set  
In order for sta members to monitor the social cloud, you must rst add the Social Monitor component to one or more
navigation sets.

Social monitoring must be enabled for your site. To enable social monitoring, contact your Oracle account manager.

1. Click Conguration on the navigation pane.
2. Expand Application Appearance, and then double-click Navigation Sets.

The Navigation Sets explorer displays on the content pane.
3. Double-click the navigation set that you want to add the Social Monitor component to.

The navigation set opens on the Navigation Sets editor.
4. On the upper portion of the right column on the content pane, select Social Monitor.
5. On the left side of the content pane, click the plus sign next to  Components > Service .
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6. Drag the Social Monitor component from the left column and drop it in the lower portion of the right column
to add it to the Social Monitor navigation buon.

7. Click Save.

Related Topics
• Overview of Navigation Sets

• Add Social Monitor Permission to a Prole

• Congure Access to the Social Monitor

Add Social Monitor Permission to a Prole  
Social monitoring is not fully available until Social Monitor permission has been added to one or more proles.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.

The Proles report displays on the content pane.
3. Double-click the prole you want to add Social Monitor permission to.

The Proles editor displays on the content pane.
4. If the Navigation Set eld in the Interfaces section does not display the navigation set that you added the Social

Monitor component to, click Search.
5. Click Permissions.
6. Click the Service tab.
7. Select Select All in the Social Monitor section.
8. Click Save.

Now, when sta members with this prole run any of the social monitoring reports, they can schedule cloud searches,
ignore results, respond to posts, and manage favorites.

Before sta members can search the social cloud, you must update their sta account to use a prole containing Social
Monitor permission. See Add or Edit a Sta Account.

Related Topics
• Add the Social Monitor Component to a Navigation Set

• Congure Access to the Social Monitor

How You Monitor the Social Cloud  
To monitor the social cloud, you will add, execute, and analyze cloud searches for any of the available social channels.

As each new cloud search is added, it is listed on the content pane along with information about who added it, what
social channel is searched, what text is searched for, the time it was last executed, and how many results have been
returned. A search can also be designated as a favorite, which prevents it from being deleted and enables it to be
scheduled on a recurring basis.

To view the results of a cloud search, simply click a total listed in the New Results or Total Results column. The content
pane will display a report based on the social channel you chose when searching. Twier, Facebook, and RSS searches
can return a maximum of 100 new results per search instance, while YouTube searches are limited to 50 new results.
Results returned over multiple searches are combined in the Total Results statistic.
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Note:  Social monitoring reports can also be accessed directly in Public Reports/Common/Social Monitor.
See Overview of the Analytics Explorers. For a complete list of social monitoring report names, locations, and
descriptions, generate the View Report Descriptions report in the Report Management component and lter
on the Social Monitor reports in Public Reports/Common/Social Monitor. See How to Monitor Report Usage.

You can manage your favorite cloud searches and subscriptions, schedule cloud searches, ignore or respond to posts,
and create incidents from posts. You can also append posts to existing incidents as note thread entries.

The social channels available for cloud searches are congured through the Channels editor. In addition, the Channels
editor provides a utility for viewing and managing cloud searches that have been added for each channel. With the
Cloud Search Manager, you can view and manage the list of agents who have selected each search as a favorite as well
as remove searches that were entered incorrectly or are no longer needed.

Related Topics
• How You Manage Favorites

• Social Channels

• Access the Social Monitor

• Manage Cloud Searches for a Channel

Social Monitor Conguration Seings  
There are certain conguration seings that impact social monitoring.

You should customize the following conguration seings to suit your organization’s social media strategy.

• The CLOUD_INCIDENT_REOPEN_DEADLINE conguration seing controls the timeframe in which a solved
incident will reopen to allow a post to be appended to the incident thread.

• The PURGE_CLOUD_RESULTS conguration seing controls when cloud search results that are not responded
to, ignored, or added to an incident are automatically deleted from the system. The default value is seven days.

Related Topics
• How You Customize Conguration Seings

Access the Social Monitor  
Use the Social Monitor to view and lter information related to you cloud monitoring results.

1. Click Social Monitor on the navigation pane.
2. Double-click Social Monitor in the navigation list.

Note:  Search results do not display on the content pane until you perform a cloud search. See Add a
Cloud Search.

The Social Monitor opens on the content pane.
The docked lters at the top of the content pane are used to search for information that is displayed in the
Social Monitor dashboard. The lters include start and end dates—in relative or absolute format—and whether
responses to social incidents should be shown in the results.

The Social Monitor dashboard results are divided into three sections.

◦ Favorites—Contains a list of previous cloud searches. Each time you perform a new cloud search, it is
automatically marked as a favorite and added to this section. See How You Manage Favorites.
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◦ Subscriptions and Mentions—Contains a list of cloud searches that have been added on a subscription
basis and mentions of Twier channel accounts in customer tweets. See Add a Cloud Search.

◦ Private Messages—Contains messages received through Facebook and Twier private messages. See
Respond to a Facebook Post and Respond to a Twier Post.

Group/Buon Description

Actions
 

Add
 

Click to add a cloud search.
 

Add Favorite
 

Click to add the selected cloud search as a favorite.
 

Remove Favorite
 

Click to remove the selected cloud search as a favorite.
 

Refresh
 

Click to refresh the Social Monitor and update any rows that have been acted upon in
the associated report.
 

Cloud Search
 

Execute
 

Click to execute all selected cloud searches.
 
The data in the New Results and Total Results columns may change as a result of this
action.
 

Get More Results
 

Click to retrieve additional results based on your initial search. This buon is disabled
unless additional search results are available.
 

View Results
 

Click to view search results from the selected cloud search.
 
If more than one cloud search is selected, this buon is disabled as results can be
viewed for only one search.
 

View
 

Favorites
 

Click to list only the cloud searches that you have selected as favorites.
 

All Searches
 

Click to list all cloud searches.
 

Topic Monitoring
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Group/Buon Description

Note:  Cluster Results, Edit Themes, Check Status, and Reset Clustering require the Marketing daemon to be running
before buons are active on the ribbon.

 

Cluster Results
 

Click to cluster the selected cloud search results.
 
If themes are specied, they are used during the clustering process. See Topic
Monitoring for Cloud Searches.
 

Edit Themes
 

Click to edit the themes used in clustering. See Edit a Theme for Clustering.
 

Check Status
 

Click to check the status of clustering. See Cluster Cloud Search Results.
 

View Previous Results
 

Click to open the Topic Monitoring for Cloud Results report, where you can view
previous clustering results.
 

Reset Clustering
 

Click to recluster the cloud search results without using themes. See Cluster Cloud
Search Results.
 

Analyze
 
See Overview of Managing Reports on the Reports Explorer.
 

Auto Filter
 

Click to enable auto-ltering in the report. Auto-ltering provides column ltering after
the report has been generated.
 

Sort
 

Click to open the Sort window and select which output columns to sort by and the sort
method.
 

Rollups
 

Click to select rollup options and open the Rollups window.
 

Slice
 

Click to select slice options and open the Slice window. Slicing groups data so you can
view only the subset of records you are interested in.
 

Add a Cloud Search  
The rst step to monitoring the social cloud is to add cloud searches.

Using cloud searches you can search for posts mentioning your organization, products, services, or anything else
related to your organization that you are interested in. You can also add subscriptions to monitor all content from an
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entire Facebook page or RSS feed, or select a Twier channel account to monitor all tweets and public replies sent from
your customers through Twier.

1. Click Social Monitor on the navigation pane.
2. Double-click Social Monitor in the navigation list.

The social monitor displays on the content pane.
3. Click Add.

The Add Social Monitor window opens.
4. Click Add New Cloud Search and select the social channel you want to search.

The channel is added to the list of cloud searches.

Field Description

Channel
 

The name of the social channel that the cloud search will be performed on.
 

Search Text
 

The text that the social monitor will search the social channel for.
 

Delete
 

Click to remove the cloud search from the table.
 

5. Enter a search term, such as your organization name or product name, in the Search Text eld.

Note:  With the exception of RSS feeds, all search terms are controlled by the social media service you
are searching. Since RSS feeds do not have a search function, the feed content is retrieved and stored
in the cloud_results table. The following three search rules apply when searching RSS data.

◦ Exact match searching—When performing an exact match search, the rst and last
characters of the search string must be double quotes.

◦ Multiple keyword searching—When performing a search with multiple search words,
an OR operator is assumed. Do not use double quotes when performing a multiple
keyword search.

◦ Regular expression searching—Any search that is not an exact match search or multiple
keyword search is treated as a regular expression search. This search feature is for
advanced users only. See Reference Information.

6. To add a subscription for a custom Facebook or RSS channel, select Subscription.
Because subscriptions pull all available channel content every fteen minutes, you cannot enter search text or a
recurrence schedule for a subscription.

7. To search for all tweets and public replies sent from your customers to your Twier channel account, select
Monitor @Mentions and select the channel account.

8. To lter and return search results for a specic language, enter the two-leer  ISO-639-1 language code .
English (en) is the default language code.

Note:  Language lters apply only to cloud searches for Twier and YouTube.

9. To lter and return Facebook search results for a specic language locale, enter a ve-leer locale code in the
Language eld. For example, the locale code for United States English is en_US.
More information on locale codes can be found  here .

10. To add multiple searches, click Add New Cloud Search again and repeat the steps above before closing the Add
Social Monitor window.
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11. Click OK.
The Add Social Monitor window closes and the cloud search is added to the social monitor. Text searches are
added to the Favorites section, while subscriptions are added to the Subscriptions section. Your new search
can now be accessed by other sta members when they click All Searches.

12. Click a link in the New Results or Total Results column to open the search report.
Results for searches you select are displayed on a separate content pane tab. Depending on your search terms,
searching the social cloud may take a few minutes. During this time, buons on the ribbon are disabled.
The appearance of cloud search results may vary based the channel you have selected. For example, while
most search results are sorted by post date, clicking a Total Results link for a Facebook search will display
results grouped by conversation, making it easier to follow comment threads from Facebook posts.

Social prole aributes can also be viewed on a contact workspace by adding the Contact Social Prole report
to the workspace. See Overview of Workspace and Script Elements.

13. To add other helpful information to cloud results for Twier and Facebook, such as additional social prole
information about post authors or whether the user has a contact record or open incident, right-click the
column headings, select Insert Hidden Column, and select the column you want to display.

Tip:  To view a more user-friendly social media display name than the user’s social media credentials,
right-click a column heading, select Insert Hidden Column, and then select Display Name.

14. To view a post in a web browser, click the Click To View link in the Post URL column.
15. To view a user’s social media prole, click the user’s ID in the User Credentials column.

The user ID is not an active link for Facebook proles.
16. To respond to a post, see How You Respond Through Social Channels.
17. To mark a post as read, select the post and click Mark Read.
18. To remove a post from the search results, see How You Ignore Posts in Search Results.
19. To create an incident from a post, select the post and click Create Incident.

After an incident has been created for a post, it can be assigned to a sta member from the cloud search report
by selecting the post and clicking Assign.

20. To exclude retweets from Twier report search results, click Search, click Include Retweets and select No, and
then click Search.

21. To lter the list of posts by the number of followers per social media user name, click Search, enter a number in
the Number of Friends/Followers eld, and then click Search.

Related Topics
• How You Monitor the Social Cloud

How You Ignore Posts in Search Results  
You can ignore search results returned by the social monitor that are not relevant to your purposes.

With the large number of new posts appearing in the social cloud each day, you want to ignore posts that do not apply
and focus on the ones that do. This function is enabled by default and can be disabled by prole, giving you the option
to reserve its use for your most reliable or experienced agents.

Note:  The Social Monitor Daily Trend, Social Monitor Hourly Trend, and Social Monitor Monthly Trend reports
(Public Reports/Common/Social Monitor/Trend) help you track ignored results by specic intervals. In
addition, you can monitor how often specic agents are using the Ignore Results function with the Social
Monitor Ignored Posts report (Public Reports/Common/Social Monitor) and Social Monitor Ignored Post
Trend report (Public Reports/Common/Social Monitor/Trend).
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Related Topics
• Ignore Search Results

• Remove Ignore Results Permission by Prole

Ignore Search Results  
Ignore search results returned by the social monitor.

1. From an open cloud search report, select the posting you want to remove from the search results list. To
remove multiple postings, press Ctrl while selecting each posting.

2. Click  Ignore Result.

Related Topics
• How You Ignore Posts in Search Results

• Remove Ignore Results Permission by Prole

Remove Ignore Results Permission by Prole  
Control which proles should have permission to ignore social monitor search results.

1. Click Conguration on the navigation pane.
2. Expand Sta Management, and then double-click Proles.
3. Double-click the prole you want to remove the permission from.

The Proles editor displays on the content pane.
4. Click Permissions.
5. Click the Service tab.
6. Clear Ignore Results in the Social Monitor section.
7. Click Save.

Now, when sta members with this prole run any of the social monitoring reports, they will no longer see the Ignore
Results buon on the ribbon.

Related Topics
• How You Ignore Posts in Search Results

• Ignore Search Results

Monitor Private Messages from Facebook  
In addition to posting public messages on your custom Facebook channels (fan pages), Facebook users can send private
messages that you view and respond to with social monitoring.

To set up Facebook channels to monitor private messages, see How You Add Facebook Channels.

A Facebook user can provide sensitive information related to an incident (such as account information) by transitioning
to using a Facebook private message without leaving the Facebook channel. Incidents will be updated with both public
and private customer replies, allowing agents to monitor the entire conversation in the incident response thread.

1. On the social monitor, click Favorites.
The Private Messages section of the dashboard lists each channel account monitored, its status, and the
number of new and total private messages retrieved.

2. Click a link in the New or Total column next to a channel account to view its private messages.
Search results for the channel account you select are displayed on a separate content pane tab.

3. To respond to a private message, select the message from the search results list and click Respond.
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Tip:  You can congure each Facebook channel to automatically create incidents from all private
messages it receives.

Related Topics
• Respond to a Facebook Post

• Grant Channel Account Access to a Sta Account

Monitor Private Messages from Twier  
With social monitoring, you can view and respond to private messages (or direct messages) sent by Twier users
directly to your organization’s Twier account.

• In order to receive private Twier messages from anyone, you must select the Receive Direct Messages From
Anyone seing in the security and privacy seings of your organization’s Twier accounts. See Twier.

• In order for private Twier messages to appear in the social monitor, you must enable private message
permissions in the Twier channel accounts. See Add a Channel Account for Twier and How You Respond to
Twier Posts.

After you have enabled private message permissions in a Twier channel account, the Dbstatus utility automatically
checks for private messages every fteen minutes and displays them on the social monitor. Private message search
results function like other cloud search results—you can create incidents from them, append them to existing incidents,
mark them read, or ignore them.

1. On the social monitor, click Favorites.
The Private Messages section of the dashboard lists each channel account monitored, its status, and the
number of new and total private messages retrieved.

2. Click a link in the New or Total column next to a channel account to view its private messages.
Search results for the channel account you select are displayed on a separate content pane tab.

3. To respond to a private message, select the message from the search results list and click Respond.

Tip:  You can congure each Twier channel account to automatically create incidents from all private
messages it receives.

Related Topics
• How You Add Twier Channel Accounts

• Grant Channel Account Access to a Sta Account

How You Manage Favorites  
Cloud search favorites provide easy access to cloud searches and subscriptions you want to keep track of.

When you add a cloud search, it is automatically marked as a favorite, indicated by a gold star when you view all
searches. You can view cloud searches and subscriptions added by other sta members, but they are not marked as
favorites unless you manually add them to your favorites. When you add someone else’s search as a favorite, a copy of
the search is created and added to the end of your favorites list.

Although searches cannot be deleted from the social monitor, you can remove them from your favorites and hide them
from view. To display only searches that are marked as favorites, simply click the Favorites buon.
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Note:  You can use the Cloud Search Manager on the Channels editor to view and manage the list of agents
who have selected each search as a favorite as well as remove searches and subscriptions that were entered
incorrectly or are no longer needed. See Manage Cloud Searches for a Channel.

Related Topics
• Add a Cloud Search to Favorites

• Remove a Cloud Search from Favorites

Add a Cloud Search to Favorites  
Manually add a cloud search to your favorites list.

1. On the social monitor, click All Searches.
2. Select a cloud search or subscription that is not marked as a favorite. To add multiple cloud searches as

favorites, press Ctrl while selecting each search.
3. Click Add Favorite.

Related Topics
• How You Manage Favorites

• Remove a Cloud Search from Favorites

Remove a Cloud Search from Favorites  
Manually remove a cloud search from your list of favorites.

1. Select a cloud search or subscription that is marked as a favorite. To remove multiple cloud searches from
favorites, press the Ctrl key while selecting each search.

2. Click Remove Favorite.

Related Topics
• How You Manage Favorites

• Add a Cloud Search to Favorites

Topic Monitoring for Cloud Searches  
Clustering of cloud search results can help you to more quickly analyze large amounts of cloud search results and help
you identify emerging issues.

Posts in the social cloud can often provide valuable business intelligence about issues experienced by large segments
of your customer base. However, reviewing a large number of posts can be time-consuming and tedious. To make this
easier, the social monitor provides a topic monitoring process called “clustering” that you can use to quickly analyze the
results of large cloud searches and identify posts that contain similar themes.

A theme comprises a group of keywords used to identify and group related content items. In the social monitor, themes
are automatically generated during the clustering process by processing cloud search results and identifying common
keywords. If you want to add your own keywords for clustering, you can edit the themes generated by Oracle Service
Cloud or you can create your own themes. During the clustering process, the themes you create manually are given
greater emphasis than automatically generated themes.
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Related Topics
• Cluster Cloud Search Results

• Edit a Theme for Clustering

• Add a Theme for Clustering

Cluster Cloud Search Results  
Use the clustering process to help analyze cloud search results.

1. On the social monitor, select a search and click Cluster Results.

Note:  If any themes are specied in the Themes to Include section of the Edit Themes window, they
will be used during the clustering process.

2. To check the status of the clustering process while it is running, click Check Status.

The Clustering Progress window opens.
After clustering has nished, click OK.

3. To view the Topic Monitoring for Cloud Results report, click View Previous Results.
This report enables you to view clustering results from previous cloud searches, including theme information,
result counts, and SmartSense ratings.

4. To recluster the cloud search results without using themes, click Reset Clustering.

Note:  If the Topic Monitoring for Cloud Results report is open, you must close it and click View
Previous Results again in order to see new or reset cluster results.

Related Topics
• Topic Monitoring for Cloud Searches

• Edit a Theme for Clustering

• Add a Theme for Clustering

Edit a Theme for Clustering  
You can edit keywords in existing themes used during the clustering process.

1. On the social monitor, select a search result row and click Edit Themes.
The Edit Themes window opens.
The Edit Themes window is divided into two sections.

◦ The Themes to Include section displays a list of themes that will be used in clustering.

◦ The Previously Suggested Themes section displays a list of themes that were created by Oracle Service
Cloud during the clustering process.

Suggested themes change each time cloud searches are clustered. However, you can manually edit a suggested
theme or prevent it from being automatically modied by moving it to the Themes to Include section.

2. Click Edit next to the theme you want to edit in the Themes to Include section.
The Theme Editor opens.

3. To edit a keyword, click Edit next to the keyword.
4. To remove a keyword from the list, click Remove next to the keyword.
5. To move a keyword up or down in the list, use the up or down arrow to the right of the keyword list.

1697



Oracle Service Cloud
Using Service Cloud

Chapter 11
Social Experience

Note:  When cloud search results are clustered, the keywords at the top of the list are given more
consideration than the keywords at the boom of the list.

6. To cluster results upon saving your edits, select Cluster On Save.
7. Click OK to save your edits.

Related Topics
• Topic Monitoring for Cloud Searches

• Cluster Cloud Search Results

• Add a Theme for Clustering

Add a Theme for Clustering  
Create a new theme to be used during the clustering process.

1. On the social monitor, select a search result row and click Edit Themes.
The Edit Themes window opens.

2. Click Add in the Themes to Include section.
The Theme Editor opens.

3. Enter a name for the theme in the Name eld.
4. In the Keyword eld, enter a keyword that you want associated with this theme and click Add.

The keyword displays in the Keyword list.

Note:  Multiword keywords are not supported by the topic monitor. If multiple words are entered for
a single keyword value, only the rst word will be used. If the resulting outcome produces too many
matches that are irrelevant to your search, try adding other keywords that relate to an appropriate
subset of your topic. For example, adding the multiword phrase “customer experience” as a keyword
will produce the same eect as adding the single keyword “customer,” and the word “experience”
will be ignored. For a more accurate result set, add keywords “customer” and “experience” separately
instead.

5. To edit a keyword, click Edit next to the keyword.
6. To remove a keyword from the list, click Remove next to the keyword.
7. To move a keyword up or down in the list, use the up or down arrow to the right of the keyword.

Note:  When cloud search results are clustered, the keywords at the top of the list are considered more
important than the keywords at the boom of the list.

8. To cluster results upon saving your theme, select Cluster On Save.
9. Click OK to save your theme.

Related Topics
• Topic Monitoring for Cloud Searches

• Cluster Cloud Search Results

• Edit a Theme for Clustering
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How You Respond Through Social Channels  
When monitoring social media, you can add posts from Facebook, and Twier to new or existing incidents so they can
be processed on the agent desktop.

In this way, you can document the customer interaction and provide the customer with assistance or follow-up contact.
This is useful for helping customers who have a question, thanking customers for positive comments, or participating in
a discussion about your products and services.

Note:  You cannot respond to RSS feeds or YouTube posts through Oracle Service Cloud. However, you can
create incidents from them, which can be helpful for other business purposes. To do so, simply right-click a
post and select Create Incident. These incidents will be associated with a common generic contact (such as
rss@rss.invalid).

When you create an incident from a social channel, the content of the post is added as a customer thread entry.
By default, the incident subject eld will contain the name of the channel and the leading text of the post, together
exceeding no more than 240 characters. However, you can customize the subject eld contents by editing the
CLOUD_INC_SUBJECT_TEXT conguration seing. See Overview of Site Conguration.

The method used to associate incoming social incidents with contacts varies by channel. Incidents created from Twier
and YouTube posts are associated with a contact based on social media user name, while incidents created from
Facebook are associated based on Facebook user ID. If you create an incident for a Twier or Facebook user who is not
associated with a contact, and the system identies one or more contacts whose display name is close to that of the
user, you will be prompted to associate an existing contact or create a new one. If no matching contact is found, a new
contact record is created and associated with the incident.

Note:  Contact social media user names are stored in the sm_user.username eld and can be displayed by
adding the Channel Usernames eld to a custom contact workspace.

The way you respond to social incidents also varies by channel. Oracle Service Cloud tracks the originating channel for
each incident in the incidents.channel_id eld and selects the same channel by default when you send a response. Each
response is posted back to the contact using the unique messaging conventions of the originating media service. For
example, when an agent responds to a Facebook or Twier post and leaves the incident set to a non-Solved status, and
the customer replies publicly through the same channel, the reply is automatically appended to the incident thread.

For more about responding in supported social media channels, see Respond to a Facebook Post and How You Respond
to Twier Posts.

Note:  Because social media contacts often have no email address, before you can respond to them, you
must customize your incident workspace to make the Email eld on the Contacts tab non-required, either by
modifying the eld Required aribute or by creating a workspace rule to set the aribute based on incident
channel. See Overview of Workspaces.

Respond to a Facebook Post  
You can respond to incidents created from customer posts on your organization’s Facebook fan page.

Your sta prole permissions must be set to let you create incidents.
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In Facebook, social conversations take the form of posts and comments on pages. When you respond to a post on your
organization’s Facebook page, the response appears as a comment beneath the customer’s post. The post is aributed
to the name of the Facebook page designated by the channel account, rather than the agent’s name. For information
about conguring a channel account, see How You Add Facebook Channels.

1. Perform a cloud search on a custom Facebook channel and view your search results.
2. From the open cloud search report, select the post you want to create an incident from in the search results list.
3. Click Respond.

A new incident opens on the content pane containing the details of the post.

Note:  The Respond and Create Incident buons provide the same functionality. Clicking either of
them results in a new incident opening on the content pane. Only one incident can be created from
a post.  If the contact’s social account user name is associated with previous cloud incidents, you will
be prompted to select from a list of existing incidents or create a new incident. Alternately, you can
append the post to the thread of an existing incident by clicking the Append Incident buon and
selecting an incident from the contact’s incident history or recent incidents that you have opened.

4. Select Send On Save.
The incident thread expands to reveal Facebook channel response options. The thread displays the name of
the originating channel of the post and automatically selects the same channel for the response. The default
channel account associated with the responding agent is also displayed.

Note:  When you reply to a private Facebook message, your reply will be sent as a private message
unless you clear the Send Private check box. A private conversation must be initiated by the Facebook
user.

5. If your site has more than one Facebook channel account, click the Respond As drop-down menu in the header
of the response thread.

Note:  If enabled, the Cc, Bcc, and Aach buons and the email encryption elds will not display since
you are bypassing email and responding directly to the Facebook post.

6. Fill in any remaining details for the incident. See How You Edit Incidents.
7. Click  Save.

Related Topics
• How You Respond Through Social Channels

• Proles

• Add a Cloud Search

• Grant Channel Account Access to a Sta Account

How You Respond to Twier Posts  
You can respond to incidents created from public and private Twier posts.

Twier is among the world’s most popular social media, but its architecture is dierent than most other services.
Twier posts, called “tweets,” are short messages designed mainly for public, one-way communication to a group
of followers. Tweets are posted publicly to the vast Twier global feed, where they can be accessed by anyone. In a
sense, this function more closely resembles a public message board than a conventional messaging service. Because
tweets are public and indirect, using Twier as a channel for business communication presents a signicant challenge.
Although the social monitor can track customer replies to your messages and append them to an incident as an
ongoing conversation, those back-and-forth communications can be read, reposted, and replied to by any other Twier
user. For this reason, using public tweets to resolve sensitive service issues can be risky.
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To more successfully engage with customers using the Twier channel, you should advise them to use the Twier
private messaging feature, which is also supported by the social monitor. Private messaging is an alternate, direct
messaging feature that makes interactions more secure by keeping them out of the Twier public feed.

Note:  In order to receive private Twier messages from anyone, you must select the Receive Direct Messages
From Anyone seing in the security and privacy seings of your organization’s Twier accounts. Your Twier
accounts can respond privately to anyone that sends a private message.

Oracle Service Cloud can create incidents automatically from private Twier messages when you select the
Automatically Create Incident option in the Twier channel accounts editor. See How You Add Twier Channel Accounts.

Respond to a Twier Post  
You can respond to incidents created from customer posts to your organization’s Twier account.

1. Perform a cloud search on a Twier channel and view your search results. See Add a Cloud Search.
2. From the open cloud search report, select the post you want to create an incident from in the search results list.
3. Click Respond.

Note:  If your prole lets you create incidents, the Respond and Create Incident buons provide the
same functionality. Clicking either of them results in a new incident opening on the content pane. Only
one incident can be created from a post. If your prole does not let you create incidents, the Create
Incident buon is disabled. Clicking Respond results in a warning message indicating that you do not
have the permissions required to create incidents.

a. If the contact’s Twier account user name is associated with previous cloud incidents, you will be
prompted to select from a list of existing incidents or create a new incident.

b. Alternately, click Append Incident to append the post to the thread of an existing incident and select an
incident from the contact’s incident history or recent incidents that you have opened.

A new incident opens on the content pane containing the details of the post.
4. Select Send on Save.

The response thread header expands to reveal Twier channel response options.
5. If your site has more than one Twier channel account, click the Respond As drop-down menu and select the

account you want to respond from.

Note:  To ensure the best customer experiences, the channel account you respond from must include
Private Message Response permissions. See Add a Channel Account for Twier.

6. If the customer’s Twier account is following your organization’s Twier account, the Send Private check box
will be visible and selected by default. Clear this check box to post the message to the public feed.
It’s a best practice to send messages privately whenever the option is available. If the customer’s account is not
following your organization’s account, the Send Private check box will not be shown and all sent messages will
be public.

7. If your organization’s Twier account is not yet following your customer’s Twier account, click Follow.

Note:  Following the customer’s account will let the customer to send private messages to your
organization’s account.

8. Enter your response in the response thread.
Remember to limit each response to 140 characters, the maximum number allowed by Twier.

9. Fill in any remaining details for the incident.
See How You Edit Incidents.

10. Click Save to send the response through Twier.
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Self Service for Facebook  

Overview of Self Service for Facebook  
Oracle RightNow Self Service for Facebook Cloud Service (Self Service for Facebook) is a special Facebook application
served by Oracle Service Cloud that provides your customers with access to features from Oracle RightNow Cloud
Service right from your organization’s Facebook page, in both its standard and mobile web interfaces.

CAUTION:  The Communities feature of Social Experience is not available to new Oracle Service Cloud
customers beginning with the August 2015 release. If you are an existing customer providing access to Social
Experience communities directly from your organization’s Facebook page, see  Self Service for Facebook in the
May 2015 documentation .

Using Self Service for Facebook, customers can:

• Search the Oracle Service Cloud knowledge base, including results from natural language search using Oracle
RightNow Virtual Assistant Cloud Service (Virtual Assistant), if enabled.

• Submit questions privately to your support team.

• Rate and comment on answers.

• Share service experiences on Facebook.

As needed, your agents can eld and respond to Facebook incidents right from their agent desktop. In this way, your
customers can receive the same exceptional support they receive from your other service channels without having to
leave Facebook. As a result, your organization can deliver a consistent experience to customers and fans on Facebook
while maintaining a unied view of customer interactions across all service channels.

Related Topics
• Social Channels

Self Service Features in Facebook  
Self Service for Facebook helps customers nd the information they need by browsing or searching your knowledge
base from the Facebook social networking site.

When connected, the Find Answers tab displayed in Facebook presents the same answers that are visible in the answer
search report dened for your customer portal. The report will also include results from your Virtual Assistant, if
enabled.

This image shows the Self Service for Facebook application connected to a consumer products support site.
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Similar to visiting the customer portal, customers can click an answer to view its contents, including guides, without
leaving Facebook. They can also click the Ask a Question tab to submit questions to your Oracle Service Cloud. Incidents
submied in this manner are processed by your system just like incidents submied through the customer portal, and
can then be accessed by your sta using the agent desktop.

Self Service for Facebook will create or update contact records on your site as needed, regardless of your site pass-
through authentication (PTA) seings. When customers aempt to use the Ask a Question feature for the rst time,
they will be prompted to log in to Facebook (if they haven’t already) and grant application access to basic account
information. This data will be used to link their Facebook account to their contact record in Oracle Service Cloud.
Facebook accounts will be associated with existing contacts that share the same email address (whether primary or
alternate). In a case where no matching contact is found, a new contact will be created and automatically associated
using the email address from the Facebook account. Agent responses to incidents submied through Facebook are sent
by email to that address.

When email address sharing is enabled in Oracle Service Cloud, Facebook account association is subject to a contact-
matching process. See Overview of Contacts.

Customers can also click the Your Support Account tab to view and update incidents from their recent support history.

Incidents created through Self Service for Facebook will be processed through whatever business rules and escalation
paths you have congured for your site. If a SmartAssistant rule is active, suggested answers will be displayed when
questions are submied, just as they are in the customer portal. If you want to route these incidents through a distinct
set of rule actions, you can do so by using “Incident.Channel equals Facebook” as a business rule condition. See
Overview of Business Rules.

Note:  In addition to responding to incidents submied by Facebook users, your sta can proactively monitor
and respond to Facebook wall posts using the social monitor. Although complementary, the social monitor
is separate and distinct from the Self Service for Facebook application and is congured and managed
separately in Oracle Service Cloud. See How You Monitor the Social Cloud.
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How You Congure Self Service for Facebook  
Self Service for Facebook is a component of your Oracle Service Cloud application that can be embedded in a Facebook
fan page. To enable it on your site, you must congure its seings in both Facebook and Oracle Service Cloud.

Because Facebook often revises the development environment used to manage applications, the procedures for
conguring Self Service for Facebook are subject to frequent changes. For current procedures, see  Answer ID 4193  on
our support site.

When working with social media, it is important to consider potential security risks and take the appropriate precautions
associated with third-party login information, customer data, and application code. To maintain the integrity and
security of your Self Service for Facebook application, see Overview of Security-Related Conguration Seings.
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12  Opportunity Tracking

Opportunities  

Overview of Opportunities  
An opportunity is a record in Oracle RightNow Opportunity Tracking Cloud Service (Opportunity Tracking) containing
information about a specic sale or a pending deal.

In essence, opportunities are the building blocks of your sales operation for collecting general sales information,
following sales strategy, seing forecast, and preparing and sending quote to customers. The information that is
collected during the sales cycle can be processed by Oracle RightNow Analytics Cloud Service (Analytics) to help
managers identify trends and forecast sales periods and to help you meet or exceed your quota.

Before you start working on your assigned opportunities, you’ll want to know how to access opportunities and how
opportunity information is organized. The topics in this section explain the layout you’ll be working with and show you
where the details of each opportunity are located.

Opportunity Reports  
Opportunity reports can be placed in the Opportunities navigation list or any other navigation list you have access to.

When you click Opportunities on the navigation pane, the navigation list displays all of the reports and items added to
this buon by your administrator. The Opportunities buon, plus all the other buons you have access to, are part of
the navigation set dened in your prole.

Opportunity reports can also be placed in other navigation lists, not just the Opportunities list. And if you have
permission to customize your navigation set, you can add other items, including any reports you have permission to
access, to your Opportunities navigation list or any of your lists. Double-clicking any opportunity report displays the list
of opportunities in the report on the content pane.

The information displayed on the content pane depends on the opportunities report you select and which elds
were dened when the report was created. The Recently Modied Opportunities report, for example, displays the
opportunity’s name, forecasted value, and date it was last modied.

Using buons on the ribbon, you can open, add, copy, delete, print, forward, assign, and reject opportunities and email
the contact. You can also search for opportunities, refresh the report, and reset the search criteria. Right-clicking any
opportunity displays the same functions as those on the ribbon.

Tip:  Besides searching for opportunities from a report, you can also use Quick Search to nd a specic
opportunity from anywhere in the product.

Standard Workspace for Opportunities  
Your Oracle Service Cloud application contains a standard workspace for working with opportunities, and denes which
elds you see and how the information is organized on the content pane.

Your organization may use the standard workspace, or your administrator may have created one or more customized
workspaces. Your prole denes the workspace you see when you work with opportunities, whether it is the standard
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workspace or a customized workspace. For documentation purposes, we use the standard opportunity workspace to
describe how to work with opportunities.

Opportunity Ribbon  
This table describes the buons on the ribbon of the standard opportunity workspace.

Group/Buon Description

Editor

Undock Click this buon to undock the opportunity editor from the console and display it in a separate window.

Save

Save Click this buon to save the opportunity you are currently editing or adding. The opportunity remains
open.
When you save an opportunity, it is evaluated by the rules engine. If your administrator added
opportunity rules and the opportunity matches one or more of those rules, it is possible that the
opportunity can be modied by rule actions when you save it.
 

Save and Close Click this buon to save the opportunity you are currently editing or adding. The opportunity closes.

Actions

Note:  With the exception of the New buon, the buons in this group are not active until after you save the opportunity you are adding.

New Click this buon to add an opportunity. See Add an Opportunity.

Refresh Click this buon to refresh the opportunity.

Forward Click this buon to forward the opportunity.

Print Click this buon to print the opportunity.

Copy Click this buon to copy the opportunity.

Delete Click this buon to delete the opportunity. See Delete an Opportunity.

Proong

Spell Check Click this buon to spell check the opportunity.

Related Activities

Reject Click this buon to reject the lead. See Reject a Lead.

Appointment Click this buon to create an appointment in Microsoft Outlook.

Links and Info

Links Click this buon to select a URL from the list of links added by your administrator.

Info Click this buon to see details about the opportunity, including its ID, when it was created and by
whom, and the date it was last updated and by whom. If the opportunity is in a rules state or has an
escalation level, that information also appears.
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Key Opportunity Fields  
When you open an opportunity, you see elds on the top of the content pane and record tabs on the boom.

The opportunity elds store the opportunity’s name, status, strategy, stage, rep forecast, contact association,
organization association, manager forecast, and other information that describes the properties of the opportunity.

Some of the opportunity elds are required by default, and your administrator may require that other elds also be
completed. You must complete any eld marked with an asterisk before you can save the opportunity. See Edit Key
Opportunity Fields.

Opportunity Record Tabs  
Much of the information about the opportunity is organized in record tabs, which group similar details.

For instance, all of the contacts associated with the opportunity are listed on the Contacts tab and all tasks associated
with the opportunity appear on the Tasks tab.

Note:  If you make changes on any windows accessed from the opportunity record tabs, you must save the
opportunity in order for your changes on the record tabs to take eect. If you close the record without saving
changes, your changes are lost.

Opportunities include these record tabs. Click a tab to see what information is listed and what your options are.

• Details tab—Contains elds related to opportunity competitor data, completion data, win/loss data, and
other general data. Use the elds on this tab to collect additional information about an opportunity, which is
benecial for reporting purposes. See Edit Details Tab Information.

• Contacts tab—Lists the contacts associated with the opportunity, including the primary contact and all
secondary contacts. From the Contacts tab, you can add a new or existing contact to the opportunity, open a
contact for editing, copy a contact, print contact information, remove a contact, send email to the contact, or
set the contact’s role in the opportunity. The Contacts tab displays a number in parentheses to show how many
contacts are associated with the opportunity. See Add or Edit Contact Information.

• Notes tab—Stores internal information about the opportunity. Notes are never sent to customers. You can add,
edit, or remove notes that originated by phone, fax, post, web form, or email for any opportunity based on the
type of correspondence you had with a contact or organization. And you can view the notes by opportunity,
contact, organization, or by any combination of the three. See Add or Edit a Note for an Opportunity.

• Tasks tab—Lists all of the tasks associated with an opportunity. You can add, open, copy, delete, print, and
forward tasks and mark tasks complete. Tasks can be assigned to an opportunity based on the opportunity’s
sales stage, or they can be manually assigned and associated with an opportunity by another sta member.
The Tasks tab displays a number in parentheses to show how many tasks are associated with the opportunity.
See Add or Edit a Task for an Opportunity.

• Quotes tab—Contains all quotes associated with the opportunity. From this tab you can open, create, copy,
delete, print, and send quotes to prospective and current customers. (An opportunity can contain multiple
quotes, but all of the quotes are directly associated with the opportunity you are currently editing.) The Quotes
tab displays a number in parentheses to show how many quotes are associated with the opportunity. See Add a
Quote to an Opportunity.

• Aachments tab—Lists all les aached to the opportunity. For instance, if a customer forwards you a
document that is associated with the opportunity, the Aachments tab provides a convenient location where
you can store the document for retrieval. You can add, open, download, delete, and view the properties of le
aachments from this tab.
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• Audit Log tab—Contains a permanent list of all actions associated with an opportunity, including the date of
the action, who performed the action, what the action was, and a description of the action. This information is
valuable for tracking interactions with customers, especially if more than one sta member works on the same
opportunity.

How You Work with Opportunities  
Opportunities are the building blocks of your sales operation for collecting general sales information.

When sta members in your marketing, service, or sales department discover a potential buyer for your organization’s
products or services, they can generate a lead (a prequalied opportunity) and assign it to you. Most of the time, you
work with these existing opportunities that have been created by someone else. For this reason, we have identied
procedures for working with existing opportunities rather than adding new opportunities.

At other times, however, you can add opportunities to the knowledge base. For instance, when an existing customer
contacts you by phone, fax, or email, you may want to add an opportunity to create a record of the customer’s inquiry.
See Add an Opportunity.

Regardless of how opportunities are assigned to you or where they originate, there are benets from understanding
what certain eld properties mean and how they can impact opportunities during the sales cycle. This knowledge can
help you eectively move your opportunities toward a sale.

Opportunity Statuses  
Opportunity statuses represent the current state of your opportunities.

The seven default opportunity statuses are Lead, Reject, Active, Inactive, Closed, Dead, and Lost. Your administrator
can also dene additional opportunity statuses to show a more complete representation of the opportunities in your
knowledge base.

Opportunity Status Description

Lead A lead is a prequalied opportunity that has not been accepted.

Reject A rejected lead is a prequalied opportunity that has been rejected.

Active An opportunity with the Active status is no longer a lead and is advancing in the system toward a sale.

Closed An opportunity with the Closed status resulted in a sale.

Lost An opportunity with the Lost status has been lost, for example, to a competitor.

Inactive An opportunity with the Inactive status is no longer being pursued but could be activated at a later
date.

Dead An opportunity with the Dead status is no longer being pursued.

Related Topics
• How You Work with Opportunities
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How You Work with Leads  
Leads are opportunities that are prequalied by your marketing, service, or sales department and are assigned the Lead
status.

Since leads are prequalied versions of opportunities, they appear as opportunities on the content pane. You are
assigned leads based on your organization’s processes, but you can also manually create leads and assign them to
yourself.

Note:  A lead assigned to a status that is not Lead or Reject is considered to be an opportunity.

Many of the opportunity elds for leads are populated. For instance, when you receive a lead, it already has an
organization or contact association and a description of the product or service the organization or contact is interested
in purchasing.

Accept a Lead  
Many of the opportunity elds for leads are populated. For instance, when you receive a lead, it already has an
organization or contact association and a description of the product or service the organization or contact is interested
in purchasing.

1. From an open opportunity, click Status.
2. Select Active to convert the lead into an active opportunity.
3. Click Save.

To represent the movement of leads to opportunities and vice versa, all actions are recorded to the audit log and display
on the Audit Log tab.

Reject a Lead  
You can reject a lead from an open opportunity.

1. From an open opportunity, click Reject.
The Reject Lead window opens.
If your prole does not let you reject leads, the Reject buon is not active.

2. Click the Rejection Reason drop-down menu and select a rejection reason.
3. To provide additional information, enter a comment in the Comments eld.
4. Click OK to close the Reject Lead window.
5. Click Save to reject the lead and save and the opportunity.

Because rejected leads are associated with the Reject status, you must lter on the Reject status when
searching for leads that have been rejected. You can convert a rejected lead into an active opportunity by
changing its status to Active.

How You Use Sales Strategies  
Sales strategies are plans dened by your organization that include associated stages and tasks that should be
completed as you work your opportunities.

Your organization may have multiple sales strategies based on your business processes. Strategies ensure that best
practices, policies, and procedures are followed during the sales cycle.

When you select a strategy while editing an opportunity, the Stage eld populates with the rst stage of the strategy.
Any tasks associated with the strategy (including those associated with other stages) populate the Tasks tab.
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Note:  If you change a sales strategy for an opportunity, all tasks associated with the previous strategy are
deleted from the Tasks tab, and all tasks associated with the new strategy populate the Tasks tab.

Forecast an Opportunity  
A forecast is a projection of sales revenue for an opportunity that may close in a given sales period.

Each opportunity contains elds for a manager forecast and a sales representative forecast. A manager forecast is a
projection of sales revenue for an opportunity from a manager’s point of view, whereas a sales representative forecast
is a projection of sales revenue for an opportunity from a sales representative’s point of view. Sales forecasts play an
important role in helping management determine realistic sales projections for a sales period.

1. Perform one of these tasks:

◦ If you are a manager, click the Manager Forecast eld.

◦ If you are a sales representative, click the Rep Forecast eld.

2. Enter the revenue amount that you forecast to be generated by the sale in the eld.
3. Click Save.

When a quote is associated with the opportunity and the Forecast check box is selected for the quote, the Rep
Forecast eld automatically reects the amount specied in the quote. See Add a Quote to an Opportunity.

Edit Key Opportunity Fields  
After you understand the role of statuses, strategies, and forecasts, you can complete the opportunity elds to update
your opportunities.

Required elds are labeled with an asterisk next to them. Remember that you can’t save an opportunity without
completing all of the required elds.

1. From an open opportunity, enter eld information.

Field Description

Click this buon to add or change the priority notications for the opportunity.

*Opportunity Name Enter the name of the opportunity in this eld.

*Status Click this drop-down menu and make a selection to change the opportunity’s status.
See Opportunity Statuses.

Strategy Click this drop-down menu and make a selection to change the opportunity’s strategy.
See How You Use Sales Strategies.

*Stage Click this drop-down menu and make a selection to change the opportunity’s stage. See
How You Use Sales Strategies.
The options in this eld depend on the strategy assigned to the opportunity.
 

Rep Forecast Enter a new value to change your monetary forecast for the opportunity. See Forecast
an Opportunity.
The Rep Forecast eld is associated with the Exchange Rates calendar. After you select
a date within a specic exchange period, the calendar defaults to the start date of the
specic exchange period after you close the calendar. The type of currency that appears
in the Rep Forecast eld depends on the default currency dened in your sta account.
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Field Description

However, you can change the default from the Personal Seings option on the Oracle
Service Cloud Options window. See Change Your Personal Seings.
 

*Rep Commit Click this drop-down menu and select Yes to commit to closing the opportunity in the
dened sales period.
This drop-down menu is not active until a value is entered in the Rep Forecast eld.
 

Summary Enter a summary about the opportunity.

Contact Click this buon to add a primary contact to the opportunity. If a primary contact is not
associated with an opportunity, an organization must be associated. Although many
contacts can be associated with an opportunity, only one of them can be designated as
the primary contact.

CAUTION:  If you use the Search buon on the Contact eld to add a contact
to the opportunity when a primary contact for the opportunity already exists,
 the existing primary contact is removed from the opportunity and replaced
with the new primary contact.

Organization Click this eld to add an organization to the opportunity. If an organization is not
associated with an opportunity, a primary contact must be associated.
Only one organization can be associated with an opportunity.
 

Assigned Click this drop-down menu to re-assign the opportunity to another sales representative.
The list of sta members that displays in the drop-down menu is the same list that
displays in the Salesperson eld of the contact record. See Add or Edit Contact
Information.
Also be aware that because of the account hierarchy in Opportunity Tracking, if a
manager account is disabled, that manager’s name continues to display as read-only
in the Assigned drop-down menu of the opportunity workspace. This allows sta
members who reported to that manager to display underneath the former manager
until another manager is designated. Refer to Sta Management.
 

Tip:  Use the Find eld at the boom of the Assigned drop-down menu to
quickly locate sta members. Wildcards are supported when searching sta

members. You can search strings that include a space by entering %+Space
+character, which is helpful when searching last names. For example,

 typing %+Space+b returns all last names starting with the leer b. There is

also an implied wildcard when searching, so typing b in the Find eld returns

all items containing the leer b.

Territory Click this drop-down menu to re-assign the opportunity to another territory.

Manager Forecast Enter a new value to change the manager forecast for the opportunity. See Forecast an
Opportunity.
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Field Description

The Manager Forecast eld is associated with the Exchange Rates calendar. After you
select a date within a specic exchange period, the calendar defaults to the start date
of the specic exchange period after you close the calendar. The type of currency that
appears in the Manager Forecast eld depends on the default currency dened in your
sta account. However, you can change the default from the Personal Seings option
on the Oracle Service Cloud Options window.
 

*Manager Commit Click this drop-down menu and select Yes to commit to closing the opportunity in the
dened sales period.
This drop-down menu won’t be active until a value is entered in the Manager Forecast
eld.
 

2. Click Save.

Edit Details Tab Information  
Fields on the Details tab are used to collect additional completion and win/loss information for your opportunities and
are useful for reporting purposes.

1. From an open opportunity, enter eld information.

Field Description

Completion Data This section contains elds for selecting forecast close information and completion
dates for the opportunity.

Forecast Close To change the date the opportunity is forecasted to close, enter a date or click the
calendar and select a new date from the calendar.

Date Closed To change the date an opportunity closes, enter a date or click the calendar and select a
new date from the calendar.

Closed Value To change the closed value for the opportunity, type a new value in this eld.
The Closed Value eld is associated with the Exchange Rates calendar. After you select
a date within a specic exchange period, the calendar defaults to the start date of the
specic exchange period after you close the calendar. The type of currency that appears
in the Closed Value eld depends on the default currency dened in your sta account.
However, you can change the default from the Personal Seings option on the Oracle
Service Cloud Options window.
 

Win/Loss Data This section contains elds for selecting win/loss reasons for the opportunity.

Win/Loss Reason To change the reason an opportunity was won or lost, click this drop-down menu and
make a selection.

Win/Loss Description This eld lets you provide additional information about why an opportunity was won or
lost. If you need to change it (for example, to make the description more specic), enter
your changes in this eld.
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Field Description

Lost To change the date that an opportunity was lost, type a date or click the calendar and
select a new date from the calendar.

Opportunity Competitors Click this drop-down menu and select the competitors that were also pursuing the
opportunity.

Note:  A check box and an option appear next to each competitor in the
drop-down menu. You can select multiple check boxes to show that multiple
competitors are involved, but you can select only one option to designate the
primary competitor.

Other Data This section contains elds for entering miscellaneous data about the opportunity.

Date of Initial Contact To change the date that initial contact was made with the customer, enter a date or click
the calendar and select a new date from the calendar.

Source This eld displays the source of the opportunity’s creation in Oracle Service Cloud.
This is a read-only eld.
 

Recall To change the reminder date that you should contact the customer, enter a date or click
the calendar and select a new date from the calendar.

2. Click Save.

Contacts Tab Toolbar  
This table describes the Contacts tab toolbar buons.

Buon Description

Add Click this buon and select one of the following options to add a new or existing contact to the
opportunity.

> Add New Select this option to display the New Contact window. After creating and saving the new contact, the
contact is added to the contact list for the opportunity.

> Add Existing Select this option to display the Contact Search window. After nding and selecting the existing
contact, the contact is added to the contact list for the opportunity.
Your administrator can add a secondary report to the Contact Search window. This feature is especially
useful for displaying all contacts associated with an organization when you add a contact to an
organization’s opportunities.
 

Open Click this buon to open the selected contact.

Print Click this buon to print the selected contact.

Copy Click this buon to copy the selected contact.

Delete Click this buon to permanently delete the selected contact.

Remove Click this buon to remove the selected contact from the opportunity (without deleting the contact).
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Buon Description

This does not delete the contact from the knowledge base. It just disassociates the contact from the
opportunity.
 

Email Click this buon to send an email to the selected contact.

Set Contact Role Click this buon to open the Set Contact Role window. To add a contact role, do the following:
Click the Contact Role drop-down menu and select the role the contact has in this opportunity.
 
Click OK to close the Set Contact Role window. The contact role displays in the Contact Role column on
the contact list.
 
Because contact roles are specic to Opportunity Tracking, you can add or edit a contact role only
while adding or editing an opportunity.
 

Options Click this drop-down menu to choose report options.

Add or Edit Contact Information  
The Contacts tab on the opportunities workspace contains a toolbar for working with the contacts associated with the
opportunity.

When an opportunity is assigned to you in the form of a lead, the contact information is often present. Sometimes,
however, only an organization is associated with the opportunity, so you must add contact information.

1. From an open opportunity, click the Contacts tab.
2. Perform one of these tasks:

◦ Click  Add > Add New  on the toolbar. The New Contact window opens.

◦ To edit a contact for the opportunity, right-click the contact and select Open. A window containing the
contact’s information opens. (The contact edit window contains the same elds as the New Contact
window.)

3. Enter eld information.

Field Description

Click this icon to add or change the priority notications for the opportunity.

*First Name Enter the contact’s rst name.

*Last Name Enter the contact’s last name.

*Primary Email Invalid Specify if the primary email address is valid or invalid.

Email Address Enter the contact’s primary email address.
If the contact has multiple email addresses, click the drop-down menu and select Email
Alt1 or Email Alt2 and add the contact’s alternative email addresses.
 

Oce Phone Enter the contact’s oce phone number.
If the contact has multiple phone numbers, click the drop-down menu and select Mobile
Phone, Fax Phone, Assistant Phone, or Home Phone and add the contact’s other phone
numbers.
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Field Description

 

Address Click Edit to open a window for entering the contact’s address. Enter information in the
Street, City, and Postal Code elds, and make selections from the Country and State/
Prov. elds drop-down menus. When you select the country, the associated states or
provinces appear in the States/Prov. menu. Close the window to display the address you
entered.

Channel Usernames Click Add in this eld to open the Channel Usernames window where you can add
Facebook, Twier, and YouTube user names for contacts.
This eld does not display unless your administrator has congured a custom contact
workspace for the Channel Usernames eld.
 

Contact Type Click this drop-down menu to select the type of contact you are working with.

*State Click to select one or more of the following: Service, Outreach, or Opportunities. Or, click
X to delete.

Organization Click the Search icon to open the Organization Search window and search for an
organization to associate with the contact.

Salesperson Click this drop-down menu and select the salesperson who is associated with the
contact.
This eld defaults to the sta member who created the contact record.
 

Title Enter the contact’s job title in this eld.

Login Enter a login for the customer to use when logging in to the customer portal. If the
customer created an account on the customer portal, this eld displays the login
selected by the customer.
This eld applies only to Oracle Service Cloud.
 

SLA Click this eld to add an SLA instance.

Global Opt-in Click this drop-down menu and select Yes if the contact wants to receive Oracle Service
Cloud mailings and surveys. Select No if the contact does not want to receive Oracle
Service Cloud mailings and surveys.

4. Click OK to add the new contact record and associate it with the opportunity.

Add or Edit a Note for an Opportunity  
From the Notes tab, you can add opportunity-related details to an opportunity.

You can also choose the origin of the note you’re adding (phone, fax, post, web form, or email) to accurately document
the origin of the note information. And you can edit notes after you add them. Notes are internal and are never sent to
customers.
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By default, the Notes tab opens with only opportunity notes displayed. If there’s a contact or organization associated
with the opportunity, and the Notes tab of the contact or organization record has notes associated with it, those notes
can also be displayed.

1. From an open opportunity, click the Notes tab.
2. Perform one of these tasks:

◦ To add a note, click Add.

◦ To edit a note, click Edit next to the note header bar.

3. Click the Opportunity Note drop-down menu and select one of the following channels where the opportunity
note information originated:

◦ No Channel—The note information originated as something other than a phone call, fax, postal mail,
web form, or email.

◦ Phone—The note information originated as a phone call.

◦ Fax—The note information originated as a fax.

◦ Post—The note information originated as postal mail.

◦ CSS Web—The note information originated from a web form.

◦ Email—The note information originated as email.

If Outlook integration is activated, Outlook email can be appended to opportunities, contacts, organizations,
and incidents in the Email format.

4. Click in the text area and type the note.
5. Click Save.

View Contact and Organization Notes While Editing an Opportunity  
Use this procedure to view contact and organization notes when editing opportunities.

To edit a contact or organization note, you must edit the contact or organization record.
1. From an open opportunity, click the Notes tab.
2. Click the View drop-down menu and perform any of these tasks:

◦ To view all associated opportunity notes, select Opportunity Notes.

◦ To view all associated contact notes, select Contact Notes.

Note:  A contact must be associated with the opportunity for contact notes to display.

◦ To view all associated organization notes, select Organization Notes.

Note:  An organization must be associated with the opportunity for organization notes to
display.

Tasks Tab Toolbar  
This table describes the Tasks tab toolbar buons.

Buon Description

Add Click this buon and select one of the following options to add a new or existing task.

 > Add New Select this option to add a new task to associate with the opportunity.

1716



Oracle Service Cloud
Using Service Cloud

Chapter 12
Opportunity Tracking

Buon Description

 > Add Existing Select this option to search for an existing task to associate with the opportunity.

Open Click this buon to open the task for viewing or editing.

Print Click this buon to print the task.

Copy Click this buon to copy the task.

Delete Click this buon to permanently delete the task.

Remove Click this buon to remove the selected task from the opportunity (without deleting the task).

Complete Click this buon to complete the task.

Forward Click this buon to forward the task to the selected recipient.

Options Click this drop-down menu to choose report options.

Add or Edit a Task for an Opportunity  
Most tasks are added automatically to the Tasks tab when a sales strategy is selected for the opportunity although you
can also manually add tasks.

You can view all tasks associated with an opportunity by clicking the opportunity’s Task tab. The Tasks tab contains a
toolbar for working with the tasks associated with the opportunity. See Tasks Tab Toolbar.

1. From an open opportunity, click the Tasks tab.
2. Perform one of these tasks:

◦ Click  Add > Add New . The New Task window opens.

◦ Right-click a task on the Tasks tab and select Open.

The New Task window opens with your name displaying in the Assigned eld and the opportunity name
displaying in the Opportunity eld. The Task type eld displays Opportunities because the task was created
while editing an opportunity.

3. Enter eld information.

Field Description

*Name Enter the name of the task.

Assigned Click this drop-down menu and select a sta account.

Tip:  To quickly nd and select a name in the list of sta members that
displays in the drop-down menu, enter the leers of the sta member’s name
in rapid succession until the name is highlighted, then press Enter.

*Status Click this drop-down menu and select a status. Options included are Not Started, In
Progress, Completed, Waiting, Deferred.

Percent Complete Enter a value for the percentage of the task that is complete.

Priority Click this drop-down menu and select a priority. Options included areLow, Normal, High.
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Field Description

Due Date Click this calendar menu and select a due date.

Planned Completion Click this calendar menu and select a planned completion date.

Date Completed Click this calendar menu and select the task’s actual completion date.

Task Type This eld contains Opportunities and is not active since the task type is determined by
the type of record you add the task from.
If you were adding a standalone task, the eld would be empty, and if you were adding a
task from any other type of record, the eld would contain that record type.
 

Notes Enter any notes about the task in this eld. You may need to scroll down to see this eld.

*Opportunity Click the Search icon to open the Opportunity Search window, where you can associate
an opportunity with the task.

Organization Click the Search icon to open the Organization Search window, where you can associate
an organization with the task.

Contact Click the Search icon to open the Contact Search window, where you can associate a
contact with the task.

Incident Click the Search buon to open the Incident Search window, where you can associate
an incident with the task.

Answer Click the Search icon to open the Answer Search window, where you can associate an
answer with the task.

Campaign Click the Search icon to open the Campaign Search window, where you can associate a
campaign with the task.

Mailing Click the Search buon to open the Mailing Search window, where you can associate a
mailing with the task.

Survey Click the Survey icon to open the Survey Search window, where you can associate a
survey with the task.

Document Click the Search icon to open the Document Search window, where you can associate a
document with the task.

4. After completing the required elds, click OK to associate the task with the opportunity.

Add an Opportunity  
This procedure shows you how to add an opportunity.

While most of your opportunities are assigned to you, undoubtedly there are times when you need to add an
opportunity to create a record of a customer’s inquiry. When adding an opportunity, all required elds must be lled in
before you can save it, including any required elds congured by your administrator. The remaining elds on all tabs
can be lled in at a later time.

1. Click  File > Opportunity .
2. Complete opportunity elds as described in Edit Key Opportunity Fields.
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3. To add detailed information to the opportunity, click the Details tab and complete the information as described
in Edit Details Tab Information.

4. To add or edit contact information for the opportunity, click the Contacts tab and complete the information as
described in Add or Edit Contact Information.

5. To add or edit note information for the opportunity, click the Notes tab and complete the information as
described in Add or Edit a Note for an Opportunity.

6. To add or edit task information for the opportunity, click the Tasks tab and complete the information as
described in Add or Edit a Task for an Opportunity.

7. To add quote information to the opportunity, click the Quotes tab and complete the information as described in
Add a Quote to an Opportunity.

8. To aach one or more les to the opportunity, click the Aachments tab and follow the instructions described
in Browse for a File to Aach to a Record.

9. To view the audit log for the opportunity, click the Audit Log tab and complete the information as described in
Audit Logs

10. Click Save.

Close an Opportunity  
Your ultimate goal with an opportunity is to close it, since an opportunity with a Closed status signies an opportunity
that has resulted in a sale.

1. From the opportunity, click the Quotes tab.
2. If a quote is associated with the opportunity, select the quote that resulted in a sale. If a quote is not associated

with the opportunity, skip to step 4.
3. Select Forecast under the Forecast column.

The Rep Forecast eld automatically updates to the value of the quote that was selected.
4. Click the Status drop-down menu and select Closed.
5. Click the Stage drop-down menu and select the appropriate stage.
6. If necessary, edit the Rep Forecast eld so that it displays the correct value.
7. Click the Rep Commit eld and select Yes.
8. Click the Tasks tab and make sure the appropriate tasks are completed.
9. Click the Details tab and complete the appropriate elds under Completion Data, Win/Loss Data, and Other

Data. See Edit Details Tab Information.
10. Click Save.

Note:  Upon changing the status from Active to Closed and saving the opportunity, the Date Closed
eld on the Details tab populates with the current date. The opportunity no longer appears in most of
your reports unless you lter on the Closed status type when searching.

Delete an Opportunity  
If your prole gives you permission to delete opportunities, the Delete buon is available on the ribbon. When you
delete an opportunity, you permanently remove it from the knowledge base.

CAUTION:  Deleting an opportunity is permanent and cannot be undone.

1. From an open opportunity, click Delete.
A message asks you to conrm the deletion.

2. Click Yes to delete the opportunity.
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Note:  Sta members with the Bulk Delete permission enabled can delete up to 1000 opportunity
records at a time. See Administration Permissions and Bulk Delete.Transactions associated with
those opportunities are deleted asynchronously. Purging transactions is controlled by data lifecycle
management policies. See Data Lifecycle Management.

Other Opportunity Actions  
Besides editing and adding opportunities, you may have other opportunity management duties as well. You might, for
example, want to forward opportunities to others within or outside your organization, copy an opportunity, or make the
same change to multiple opportunities.

• Forwarding opportunities—You can send a copy of an opportunity to other recipients. For instance, your
manager may want to see all opportunities related to a particular inquiry, or you might want another sales
representative to review your opportunity data before sending a quote to a customer.

• Copying opportunities—There may be times when you need to create an opportunity that is similar to an
existing one. Rather than entering all eld information from scratch, just copy the existing opportunity and use
it as a base for the new one.

• Updating multiple opportunities—You can update, forward, and delete multiple opportunities at one time
rather than performing the same action on each opportunity individually. This saves time when you have
several opportunities that apply to the same sales product or service.

Sales Process  

How You Work with Strategies  
A strategy is a series of stages that an opportunity moves through in the sales pipeline on its way to becoming a nal
sale. Each stage of a strategy includes tasks that must be completed before the opportunity can move to the next stage.

You probably want dierent strategies for dierent kinds of opportunities. For example, you might have one strategy
to sell a high volume of products to government organizations and a dierent one to sell single products to individual
consumers.

When sta members select a strategy for an opportunity they are working on, the rst stage of that strategy
automatically populates the Stage eld. All tasks associated with the strategy (including those associated with other
stages) are also added to the opportunity.

Add or Edit a Strategy  
Add a strategy for each kind of opportunity your sta members will work on.

1. Click  Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Strategies.

The Strategies tree displays on the content pane.
3. Perform one of these tasks:

◦ To add a strategy, click New. The editor displays on the content pane.

◦ To edit a strategy, click it in the tree.
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4. Enter eld information.

Field Description

*Strategy Name Enter the name of the strategy. The item name in the Strategies tree on the left side of
the content pane and the Label eld in the Interface Visibility section are populated or
revised as you type.

Disabled Select this check box to prevent sales representatives from selecting or viewing the
sales strategy.

Notes Enter any comments about the sales strategy.

Visible Clear this check box if you do not want the strategy to be visible on the interface.

5. Because you cannot save the strategy without adding at least one stage to it, click the arrow on the New buon
and select Add a New Stage to the Selected Strategy.
The Stage Details editor displays on the content pane.

6. Enter eld information.

Field Description

*Stage Name Enter the name of the stage. The stage details item name in the Strategies tree on the
left side of the content pane and the Label eld in the Interface Visibility section are
populated or revised as you type.

Forecast Percent To enable this eld, select the Forecast Enabled check box.
The forecast percentage is an estimate of how far an opportunity has progressed in the
sales strategy when it is at this stage. For example, you might be only 5% condent that
an opportunity will close when it is in an Initial Contact stage, but 100% condent at a
Sale Complete stage. Enter a value in the eld.
 

Forecast Enabled Select this check box to enable forecasts for the stage.

Note:  You must select this check box to activate the Forecast Percent eld.

Status Type Select a status type from this drop-down menu to associate with the stage. Refer to
Adding and editing opportunity statuses.

Notes Enter any comments about the stage.

7. To add another stage to the strategy, repeat the previous steps.
8. Click Save.

Add or Edit a Stage Task  
Just as strategies contain stages, each stage can contain multiple tasks that are required to complete each stage. After
you have added a stage to a strategy, you can then add tasks to the stage.
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When sta members select strategies and stages for an opportunity, the opportunity’s Tasks tab lists the tasks
associated with the selected stage.

1. Click Conguration.
2. Expand Opportunity Tracking, and then double-click Strategies.

The Strategies tree displays on the content pane.
3. Locate the strategy you want and click the arrow to the left of the strategy to expand it, displaying the stages

associated with the strategy.
4. Click the stage where you want to add or edit tasks.

The Stage Details editor displays on the content pane.
5. Perform one of these tasks:

◦ To add a task, click the arrow on the New buon and select Add a New Task to the Selected Stage. The
Task Details editor displays on the content pane.

◦ To edit a task, click the arrow to the left of the stage to display the tasks associated with it, and click the
task you want to edit.

6. Enter eld information.

Field Description

*Task Name Enter the name of the task. The task details item name in the Strategies tree and the
Label eld in the Interface Visibility section are populated or revised as you type.

Owner Click the Search icon next to the eld to display sta accounts grouped by manager.
Select the task owner from the list and click OK to close the window and populate the
eld.

Task Interval Enter the amount of time estimated to complete the task. Select days, hours, or minutes
from the drop-down menu and then type a value in the eld.
This value is used to calculate the task due date. When a strategy is selected for an
opportunity, the associated tasks are added to the opportunity, and due dates are
calculated by adding the task interval to the current date and time.
 

Notes Enter any comments about the task.

Description Enter a description of the task.

7. To add another task to the stage, repeat the previous steps.
8. Click Save.

Note:  When you delete a strategy, the strategy is removed from the Strategy eld of all associated
opportunities and replaced with No Value. However, tasks that were associated with the strategy
(and therefore with opportunities that had the strategy assigned to them) remain associated with the
opportunities.

Add or Edit a Sales Period  
A sales quota is dened as a specic number of dollars in sales that sta must produce over a specic time frame, or
sales period.
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Opportunity Tracking lets you dene sales periods on an annual, semi-annual, quarterly, monthly, or weekly basis.
You can dene each period’s start and end dates, the total revenue goal, head count, goal for the number of closed
opportunities, and quotas for each sales representative. When you dene quotas for each salesperson, you can review
that information in reports throughout the sales period.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Sales Periods.

The Sales Periods tree displays on the content pane.
3. Perform one of these tasks:

◦ To add a sales period, click New on the ribbon to display the editor.

◦ To edit a sales period, click it in the tree.

4. Enter eld information.

Field Description

*Sales Period Name Enter the name of the sales period.

*Type Click this drop-down menu to select a sales period type. Your options include Annual,
Monthly, Quarterly, Semi-Annual, and Weekly.

*Start Date Click the calendar and select the start date of the sales period. The default is today’s
date.

*End Date Click the calendar and select the end date of the sales period. The default is tomorrow’s
date.

Revenue Goal Enter the revenue goal for the sales period and, if necessary, select a dierent currency
from the drop-down menu. This is the target level of revenue for the sales period
displayed in the selected currency, regardless of the local currency of the transactions.

Headcount Enter the number of assigned sta persons for the sales period.

Closed Opportunities Goal Enter the goal number of closed opportunities for the sales period. This is the number
of opportunities targeted to close during the sales period expressed as a positive whole
number.

Notes Enter any comments about the sales period.

Quotas Add sales quotas for each sales representative during the sales period. See Add or Edit a
Sales Quota to Sales Periods.

Filter Select Account, Amount, or Currency from the drop-down menu to lter the sta
accounts that display in the Quotas section. See Add or Edit a Sales Quota to Sales
Periods.

5. Click Save.

Note:  Deleting a sales period deletes all quotas associated with it.
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Add or Edit a Sales Quota to Sales Periods  
When you dene a sales period, you can also add a sales quota for each sta member. When you add sales quotas,
managers can generate reports to track productivity for individual sales representatives or the entire sales team.

Note:  Sales managers must have Edit Sales Period permission in their prole to edit sales quotas. See
Opportunity Tracking permissions.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Sales Periods.

The Sales Periods tree displays on the content pane.
3. Click the sales period where you want to add or edit sales quotas.

The Quotas section of the editor displays all sta accounts with proles that have the Appear in Menus
permission selected on the Opportunity Tracking tab.

4. Click the Amount eld for the account whose quota you want to add or edit, and type the value in the eld. If
necessary, select a dierent currency from the drop-down menu.

5. Repeat the previous step for each sales quota you want to add or edit.
6. Click Save.

Add or Edit a Territory or Subterritory  
Opportunity Tracking uses territories and subterritories to dene sales regions based on geography. Sta members can
be assigned to a territory or subterritory for reporting purposes.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Territories.

The Territories tree displays on the content pane.
3. Perform one of these tasks:

◦ To add a territory, click New.

◦ To edit a territory, click it in the tree.

To add multiple parent territories in the same session, you must rst press Ctrl and click the highlighted
territory in the tree before clicking New.

4. Enter eld information.

Field Description

*Territory Name Enter the name of the territory. The item name in the Territories tree and the Label eld
in the Interface Visibility section are populated or revised as you type.

Disabled Select this check box to prevent sales representatives from selecting or viewing the
territory when adding an opportunity.

Associated Accounts This read-only eld lists the sta members assigned to the territory in their sta
account.
This eld is blank if you are adding a territory.
 

Notes Enter any comments about the territory.
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Field Description

Visible Clear this check box if you do not want the territory to be visible on the interface.

Note:  If you clear a territory’s visibility, you cannot move a visible territory to
be subordinate to one that does not have visibility on the interface.

5. Perform one of these tasks:

◦ To add a subterritory to a territory, click the territory in the Territories tree, click New, and complete the
elds.

◦ To edit a subterritory, click it in the tree and edit the elds.

6. Click Save.

Quote Templates  

How You Work with Quote Templates  
When you add or edit a quote template, you use Microsoft Word to format the document.

In addition to using standard Word functions, you can insert merge elds into the quote template. The merge elds
serve as variables for opportunity data. When a sales representative merges the opportunity data into the quote
template, the appropriate elds are completed automatically.

For example, an organization name merge eld on the quote template populates the eld on the quote. This simplies
the data entry required to generate the quote and ensures accuracy and consistency.

Note:  Before sales representatives can generate quotes using quote templates, you must add price schedules
and sales products to Oracle Service Cloud. See Overview of Customizable Menus.

Add or Edit a Quote Template  
When you add or edit a quote template, you use Microsoft Word to format the document using the following procedure.

1. Click Conguration on the navigation pane.
2. Expand Opportunity Tracking, and then double-click Quote Templates.

The Quote Templates tree displays on the content pane.
3. Perform one of these tasks:

◦ To add a quote template, click New to display the editor.

◦ To edit a quote template, click it in the tree.

4. Enter eld information.

Field Description

*Name Enter the name of the quote template. The item name in the Quotes Templates tree and
the Label eld in the Interface Visibility section are populated or revised as you type.
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Field Description

Use a descriptive name that helps sales representatives select the appropriate quote
template for generating a quote.
 

Disabled Select this check box to prevent sales representatives from selecting or viewing the
quote template.

Notes Enter any comments about the quote template.

Visible Clear this check box if you do not want the quote template to be visible on this interface.

5. Click Word Editor. An instance of Microsoft Word opens in the Quote Templates editor with an Add-Ins tab for
merge elds.

6. Click the Add-Ins tab to display the Quote Template ribbon.

Note:  Because the Add-Ins tab does not exist in Word 2003, the Quote Template toolbar is a standard
toolbar instead of a ribbon.

7. Format the Word document based on your organizational policies and standards. If you have an existing
Microsoft Word template, you can copy and paste it into the Word document.

8. To insert a merge eld, place your cursor in the quote template document where you want to insert the eld.
9. Click one of the drop-down menus in the Custom Toolbars section on the Quote Template ribbon and select a

merge eld to add to the quote template.
For a complete list of merge elds and their associated descriptions, click Database, and then double-click Data
Dictionary.

Drop-Down Menu Description

Single Items Click this drop-down menu to select merge elds that have a one-to-one relationship
with opportunities. For example, because an opportunity can be associated with only
one organization, organization elds are listed in the Single Items drop-down menu.

Group Items Click this drop-down menu to select merge elds that have a many-to-one relationship
with opportunities. For example, because a quote can be associated with many sales
products, sales product elds are listed in the Group Items drop-down menu.
You must create a table with column headers before using merge elds from the Group
Items drop-down menu. After the table is created with column headers, a merge eld
from the Group Items drop-down menu must be inserted into a single cell in the table.
Word automatically adds rows to the table based on how many values are in the group.
The font of the column headers determines the font of the merge elds in the table.
 

Indexed Items Click this drop-down menu to select merge elds that have a many-to-one relationship
with opportunities and are indexed in the database. For example, because an
opportunity can be associated with many contacts, contact elds are listed in the
Indexed Items drop-down menu.
You must replace the “N” with a numeric value. While using a eld from the Group Items
drop-down menu returns all of the contacts associated with an opportunity, using a eld
from the Indexed Items drop-down menu returns only the contact you specify according
to “N” (the number one is always associated with the primary eld in a database table).
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Drop-Down Menu Description

For example, to return the email address of the primary contact who is associated with
an opportunity, contacts.email1 should be added to the quote template.
 

10. Repeat the previous step until you have added all merge elds to the quote template.

CAUTION:  If you close the instance of Microsoft Word by clicking X inside the Quote Template editor,
the Oracle Service Cloud application closes and any unsaved changes are lost. To save your quote
template without closing the application, you must click the Save and Close buon.

11. Click Save.

Quotes  

How You Prepare Quotes  
There are considerations when preparing to send a quote to a customer.

Before you can send a quote to a customer, you must add the quote to the opportunity, add sales products to the quote,
and merge the opportunity and quote information into a quote template. Only then can you send the quote.

Note:  A quote must always be associated with an opportunity. In order to create or edit a quote, you must rst
open the opportunity that is associated with the quote.

Quotes Toolbar  
The Quotes tab on an opportunity workspace contains a toolbar for working with quotes for the opportunity.

This table describes the default buons on the Quotes toolbar.

Buon Description

Add New Click this buon to add a quote to the opportunity. See Add a Quote to an Opportunity.

Open Click this buon to open the selected quote. See Edit a Quote.

Print Click this buon to print the selected quote. See Print a Quote.

Copy Click this buon to copy the selected quote. See Copy a Quote.

Delete Click this buon to delete the selected quote. See Delete a Quote.

Send Click this buon to send the selected quote to the customer. See Send a Quote to a Customer.

Options Click this drop-down menu to choose report options.

1727



Oracle Service Cloud
Using Service Cloud

Chapter 12
Opportunity Tracking

Add a Quote to an Opportunity  
Adding a quote to an opportunity is the rst step in preparing a quote.

After you add a quote to an opportunity, you complete the quote elds, add sales products to the quote, and merge the
quote data into a quote template.

1. While adding or editing an opportunity, click the Quotes tab.
2. Click Add New.

The New Quote window opens.
3. Enter eld information.

Field Description

*Name Enter the name of the quote in this eld.

Status Click this drop-down menu to select the status of the quote. Default statuses are
Unsent, Sent, Queued, Accepted, and Returned.

Unsent Select this status for quotes that have been created but not yet sent. This is the default
status for new quotes.

Sent This status is automatically selected when a quote is sent to a customer.
After a quote is sent to a customer, you cannot edit the quote again unless your prole
gives you permission.
 

Queued Select this status if the quote is waiting to be reviewed.

Accepted Select this status if the quote has been sent and the customer has accepted it.

Returned Select this status if the quote has been returned because it needs to be renegotiated or
because it was rejected by the customer.

Schedule Click this drop-down menu to select a price schedule to associate with the quote. (Your
administrator has added dierent price schedules based on your organization’s needs.)

Product list When you select a price schedule, all sales products that are associated with the
schedule appear in the product list below the Schedule eld. If the products are
organized in folders, click the plus sign next to a folder to expand it and show the
products within that folder. You can then double-click or drag and drop products to add
them to the quote.

Sales product grid After you select a schedule and add one or more sales products from the product
list, the sales product grid displays details about the added sales products. See Sales
Products and Quotes.
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Field Description

Note:  Working with sales products in the grid modies the products only
for the quote you are editing and does not change the sales product in the
product catalog. If, for example, you discount the product in the sales product
grid for a particular quote, the original price is unchanged in the product
catalog.

Adjusted Name This column displays the product’s name.

Original Price This column displays the product’s price as it is dened in the product catalog for the
price schedule you selected.

Adjusted Price This column displays the adjusted price of the product, which you can edit by selecting a
product in the sales product grid and opening it.

Quantity This column displays the quantity of the product included in the quote.

Discount This column displays the discount percentage applied to the sales product.

Total This column displays the total adjusted price for the sales product, taking into account
the quantity selected and the discount applied to that specic product.

Action After a sales product has been added to the list, choose one of the following actions:
Open—Opens the quote product editor and where you can make changes to the
product.
 
Delete—Deletes the sales product from the quote.
 

Quote Total This read-only eld displays the sum of product totals for all the products in the quote.
It includes the discounts applied to the specic products in the quote, but it does not
include the discount for the entire quote, which you can enter in the % Discount eld.

% Discount Enter the percent discount to be applied to the entire quote, or use the arrows to
increase or decrease the value.

Grand Total This eld displays the total price for the quote after the quote discount has been
applied.

Oer Start Date Click this calendar to select the start date for the quote from the current month’s
calendar. If necessary, use the arrows at the top of the calendar to move backward or
forward by month.

Oer End Date Click this calendar to select the end date for the quote.

Quote Document If the quote information has not been merged into a quote template yet, Aach Quote
is active. Click Aach Quote to merge the quote with a quote template. See Merge
Opportunity and Quote Data into a Quote Template.
After quote information has been merged into a quote template, this section displays
the name of the quote as well as options to edit and delete the quote.
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Field Description

Notes Enter a description of the quote in this eld.

4. Click OK to close the New Quote window and add the quote to the opportunity.
5. Click Save.

Quote Product Editor  
This table describes the elds on the Quote product editor.

Field Description

Original ID This read-only eld displays the product ID.

Original Name This read-only eld displays the product name.

Original Price This read-only eld displays the price assigned to the product in the price schedule you selected for
the quote.

Original Description This read-only eld displays the product’s description.

Adjusted ID Enter a product ID in this eld if you want to modify the original ID.

Adjusted Name Enter a product name in this eld if you want to change the product’s name in the quote.

Adjusted Price Enter a price in this eld if you want to change the original price of the product for this quote. The
value you enter appears in the Adjusted Price column on the sales product grid.

*Quantity Enter a quantity in this eld if you want to change the default value of 1. Changing this eld aects the
value of the Total column on the sales product grid.

*Discount Enter a percent discount in this eld if you want to change the default value of 0. Changing this eld
aects the value of the Total column on the sales product grid.

Adjusted Description Enter a description in this eld if you want a description other than the original description.

Notes Enter any notes about the product quote in this eld.

Sales Products and Quotes  
When you add a quote to an opportunity, you must select a price schedule in the Schedule drop-down menu on the
New Quote window.

Your administrator added the price schedules, and each price schedule corresponds to a specic set of sales products.
When you select a price schedule, the associated products appear in a product list below the Schedule eld.

You use the product list to select the products you want to add to the quote. After they appear in the sales product grid
on the right, you can adjust quantities and specic discounts for each product for this quote.

Note:  Editing a product for this quote does not change its price in any other quote, nor does it change the
price in the product catalog.
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Add a Sales Product to a Quote  
This procedure assumes that you have already added a quote to an opportunity, but have not yet selected a price
schedule or added sales products to the quote.

1. While editing an opportunity, click the Quotes tab.
2. Right-click the quote you want to open and select Open.

The quote editor opens.
3. Click the Schedule drop-down menu and select a price schedule for the quote.

Note:  When you select a price schedule, all sales products associated with the price schedule
populate the product list below the Schedule eld. You can click the plus sign next to folders to expand
them. The sales product grid is located next to the product list.

4. Perform one of these tasks:

◦ Double-click a sales product in the product list to move the product to the sales product grid. Information
about the sales product appears in the grid.

◦ Drag a sales product from the product list to the sales product grid.

5. To edit a selected sales product in the sales product grid, right-click the product and select Open.
The quote product editor opens.

6. Perform one of these tasks:

◦ Enter eld information described in Quote Product Editor.

◦ Click OK to save your changes, close the quote product editor, and return to the open quote.

7. Click OK to save your changes to the quote, close the quote, and return to the opportunity.
8. Click Save.

Now you can merge opportunity and quote data into a quote template to generate a quote you can send to the
customer.

Merge Opportunity and Quote Data into a Quote Template  
After you have added a quote to the opportunity and then added sales products to the quote, you have dened all the
information necessary to generate the quote for the customer.

You can merge the opportunity and quote data with a quote template. When you select a quote template from the
available options, Opportunity Tracking generates a quote you can save and send to the customer.

1. While editing an opportunity, click the Quotes tab.
2. Right-click the quote you want to merge into a quote template and select Open.

The quote editor opens.
3. Click Aach Quote.

The Select Template window opens, providing a list of available quote templates that have been dened by
your administrator.

4. Select a quote template and click OK.
The opportunity and quote data are merged into the quote template, and the Quote Viewer window opens
with the quote displaying as a Word document.

5. To edit the document, make changes using Microsoft Word.

Note:  You can make any changes you need to customize the quote document, but your changes do
not modify the quote template.
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6. To merge the same opportunity data into a dierent quote template, click Merge and select a new template
from the Select Template window.

7. Enter a name for the quote in the Custom Document Name eld to ensure that the name of the quote is
unique for the customer receiving it.

8. Click Save to save the quote and return to the quote editor.
9. Click OK to close the window and add your quote to the opportunity.

A paper clip icon appears on the Quotes tab.
10. If you want to forecast the quote to close within the specied sales period, select the Forecast check box in the

Forecast column.
After the Forecast check box is selected, the quote amount appears in the Rep Forecast eld of the opportunity.
See Forecast an Opportunity.

11. Click Save.

After saving the opportunity, you can view the quote audit log, which contains all activities related to the quote. See
Quote Audit Log.

Send a Quote to a Customer  
After you merge all necessary information about the opportunity into the quote template and have reviewed the quote,
you are ready to send the quote to your customer.

1. From the Quotes tab of an opportunity, right-click the quote you want to send and select Send.
The Send Quote window opens.

Note:  The Send option is not active unless all opportunity and quote data have been successfully
merged into a quote template. See Merge Opportunity and Quote Data into a Quote Template.

2. Enter eld information.

Field Description

To Enter the email address of the contact or sta member you are sending the quote to, or
click this buon to open the Select Names window.

Cc Enter an email address in the Cc eld to send the quote to, or click this buon to open
the Select Names window.

Bcc Enter an email address in the Bcc eld to send the quote to, or click this buon to open
the Select Names window.

Subject Enter the subject for the quote in this eld.

Comment Enter any comments in this eld.

Opportunity Files Any les that are permanently aached to the opportunity are listed in this section.
Select the check box next to any le aachments you want to send with the quote.

Temporary Files Click Add Files to select a le to send with the quote. This action does not permanently
aach the le to the opportunity.

Send as PDF Select this check box if you want to send the quote as a PDF aachment instead of the
default Word aachment.
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Field Description

If this check box does not appear, your administrator has not congured Opportunity
Tracking to send quotes as PDF documents.
 

3. Click Send to send the quote to the recipients you’ve added to the Send Quote window.

After a quote has been sent to a customer, the details of the quote (From, To, Cc, Bcc, Format, Aachments, Subject, and
Comments) are recorded as a note to the opportunity the quote is associated with. In addition, the status of the quote is
automatically set to Sent.

How You Manage Quotes  
In addition to adding and sending quotes, the toolbar on the Quotes tab lets you open a quote for editing as well as
print, copy, and delete a quote.

These options are also available when you right-click a quote. When a quote is open, you can view the audit log that lists
all activities related to the quote.

After a quote has been sent, you cannot edit it unless your prole gives you permission to do so. However, you can
make a copy of the quote, edit the copy, and then send the copied quote to a customer.

Edit a Quote  
You can edit a quote before sending it to the customer. After a quote has been sent, you cannot edit it unless your
prole gives you permission to do so.

1. While editing an opportunity, click the Quotes tab.
2. Right-click the quote you want to edit and select Open.

The quote editor opens.

Note:  You can edit only one quote at a time.

3. Modify elds as needed. See Add a Quote to an Opportunity for eld descriptions.
4. Click OK, and then click Save.

Copy a Quote  
After a quote has been sent, you cannot edit it unless your prole gives you permission to do so. However, you can
make a copy of the quote, edit the copy, and then send the copied quote to a customer.

1. While editing an opportunity, click the Quotes tab.
2. Right-click the quote you want to copy and select Copy.

The copied quote appears in the quote list with a name of “Copy of <quote>” and its status is set to Unsent.
3. Right-click the copied quote and select Open to edit as necessary. See Add a Quote to an Opportunity for eld

descriptions.
4. Click OK to save your changes to the copied quote.
5. Click Save.

Delete a Quote  
You can delete a quote from an open opportunity.

1. While editing an opportunity, click the Quotes tab.
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2. Right-click the quote you want to delete and select Delete.
A conrmation message opens.

3. Click Yes to conrm the deletion.
4. Click Save.

Print a Quote  
You can print a quote from the Quotes tab when you edit an opportunity.

1. While editing an opportunity, click the Quotes tab.
2. Right-click the quote you want to print and select Print.

The Print Dialog window opens.
3. Click  File > Print

The Print window opens.
4. Click Print.

Quote Audit Log  
All actions related to a quote are recorded to the quote audit log, which is located next to the Aachments tab on the
quote editor. Information in the audit log includes when the quote was created and updated, by whom, and the actions
taken.

Note:  Before you can see any recent actions in the audit log, you must save the opportunity the quote is
associated with.

This table describes the columns in the quote audit log.

Column Description

When This column lists the date and time of the actions.

Who This column lists the name of the sales rep who acted on the quote.

What This column lists the actions related to the quote.
Created—The rst time a quote is added to the opportunity and the opportunity is saved.
 
Assigned—The sta member the quote is assigned to.
 
Edited—The quote is edited and the opportunity is saved.
 
Forecasted/Unforecasted—The quote Forecast check box is selected or cleared and the opportunity is
saved.
 
Changed Status—The quote status is changed and the opportunity is saved.
 
Changed Price Schedule—The quote price schedule is changed and the opportunity is saved.
 
Quote Template Merged/Updated/Deleted—The quote document is merged, edited, re-merged, or
deleted and the opportunity is saved.
 
Quote Sent—The quote has been sent.
 

Description This column displays more information about the action (for example, the editor used to save or edit
the quote or the email address the quote was sent to).
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13  Security Practices

Overview of Oracle Service Cloud Security and
Compliance  
An important part of product security is your diligence in conguring Oracle Service Cloud and your vigilance in its use.

Security is a changing landscape with new aack methods continuously developing, many of which are based on social
engineering that takes advantage of user trust. The protection of our customers’ assets is a high priority at Oracle. We
strive to make your Oracle Service Cloud experience secure by holding ourselves to industry-standard security and
privacy requirements in our software development practices and operational methods. For added protection, Oracle
Service Cloud can be hosted within our community cloud environments that align with well-known regulatory control
frameworks.

See Implementing Oracle Service Cloud in a Controlled Environment, and the sections that follow it, for guidance when
deploying Oracle Service Cloud in a regulated environment.

Network and Hosting Infrastructure  
Oracle uses “defense in depth” with multiple levels of security crafted to protect everything in the hosted environment
from the network infrastructure to the software.

Oracle Service Cloud sites are hosted in security-hardened pods where each is protected by redundant rewalls and
a demilitarized zone architecture. All major services, which include web, database, and mail services, are separately
hosted and load balanced. The pods are audited daily, both internally and externally, and every quarterly software
release is subjected to a third-party audit. In addition, a dedicated security sta monitors all systems for events that
could jeopardize system reliability or data integrity.

How You Develop a Security Plan  
When conguring your Oracle Service Cloud site, your goal is to obtain the maximum eectiveness for your sta and
your customers, while ensuring that your site is safe from threats.

Although Oracle Service Cloud is designed and implemented with the highest levels of security, we recognize that
our customers’ needs vary. Therefore, we oer conguration options that let you accept various levels of risk. Your
sensitivity to those risks should dictate the conguration and management options you use in your site.

Note:  Never assume that your security system is foolproof. New aacks are designed every day, so you
should expect that any weakness will eventually be exploited. Ongoing vigilance and process improvement are
required to minimize risk.
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Common Security Threats
Risks to using a web-facing software product like Oracle Service Cloud to collect and store data include but are not
limited to:

• Data leaks to unauthorized persons.

• Aacks to subvert security measures.

• Vandalism of the host site.

• Aacks against site users.

Security Considerations
To start developing your security plan, we’ve compiled a list of questions and considerations that relate to the use of
Oracle Service Cloud. Your answers should help determine the content of your security plan. Here are some things to
consider.

• What type of data will you collect and store?

◦ Is personal information such as name, address, telephone number, and email address collected?

◦ Is medical or nancial information collected and stored?

◦ Are there required data security standards or certications, such as HIPAA or PCI?

• What methods will be used to obtain the data?

◦ Does information come over the Internet or a private intranet?

◦ Does information come from a voice-based system?

• What is the access method for the data?

◦ Are users required to provide credentials, such as a user name and password, or is data openly available?

• What are the risks associated with compromised data?

◦ What is the monetary cost?

◦ What is the non-monetary cost, such as loss of reputation?

◦ Are there legal ramications?

• Who are your user groups?

• What authentication methods are available and which should be used for each type of user?

• For each type of data, which types of users should have access and how should the authorization be
accomplished?

• What communication methods will be used and what eorts should be made to protect communication from
being compromised?

While there are many resources available that can help you develop security policies and procedures, keep in mind that
you should rely only on those resources that you nd reliable and trustworthy. If you want to read more about security,
here are some suggestions.

• Writing Information Security Policies by Sco Barman
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• Information Security Policies and Procedures by Thomas Peltier

• SANS Institute —for information about security training and security certication

• OWASP —A nonprot organization focused on improving software security

Administration Interface Conguration  
Properly conguring the administration interface is critical to your site security because sta members can be granted
permission to view and modify virtually everything in an Oracle Service Cloud site, including your site controls and data.

Oracle Service Cloud uses role-based access control through prole permissions, navigation sets, and workspaces
that you dene. All sta members are assigned a prole that is associated with a navigation set and one or more
workspaces.

• Navigation sets—A navigation set is a combination of navigation buons and their associated navigation lists.
Each navigation list contains unique reports and items based on sta member responsibilities, and every prole
must include a navigation set that all sta members with that prole use when working in Oracle Service Cloud.
By carefully examining sta member responsibilities before you create navigation sets, you can grant access to
functionality to only those individuals who require it.

• Workspaces—Workspaces dene the appearance of the agent desktop when sta members add, view, and edit
records in Oracle Service Cloud. Each prole has one or more workspaces that can be designed to provide only
the functionality that is needed by the sta member. Along with navigation sets, workspaces provide macro-
level control over access rights.

• Prole permissions—Proles let you control what areas of Oracle Service Cloud your sta members can access
and what specic actions they can perform in those areas.

Note:  You must create navigation sets before proles in order for sta members to have access to reports and
other components. In addition, if you use custom workspaces, we recommend creating them before creating
proles so you can assign the workspaces to specic proles.

Related Topics
• Overview of Navigation Sets

• Overview of Workspaces

• Custom Workspaces

• Proles

• Create a Navigation Set

• Assign a Navigation Set to a Prole

How You Use Role Access to Dene Permissions  
Seing permissions carefully and thoughtfully greatly enhances the security of your site. This is particularly true
regarding administrator permissions, which typically let sta members edit conguration seings and administrative
controls.
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One method for determining the permissions you grant is to use a role-access method. While no contrived set of
roles will represent any organization perfectly, the four job types used here demonstrate a general scenario of how
permissions might be set up.

• Administrator—Sta member with access to all functionality.

• Supervisor—Sta member with supervisory responsibilities but no responsibility for conguring your site.

• Sta member—Sta member with access to data but no administrative controls.

• Developer—Sta member with access to development and integration interfaces.

This table doesn’t contain a complete list of all the permissions available, but provides an abbreviated set representing
those permissions with direct security ramications.

Seing Functionality Roles

Administration

Administration Create and edit these items:
• Custom Fields

• Messages

• Mailboxes

• Currencies and Exchange Rates

• Service Level Agreements

• Response Requirements

• Chat Hours

• Quote Templates

• Territories

• Promotions

• Strategies

• Sales Periods

• External Suppression List

• Thread Type Correction

Administrator

Groups/Accounts/Distribution
Lists

Access sta accounts and distribution lists. Administrator
Supervisor
 

System Error Log Access log les under Site Conguration. Administrator
Supervisor
 

Workspace Designer Access Workspaces and Workows explorers
and designers.

Administrator
Supervisor
 

Scripting Create and edit agent scripts. Administrator
Developer
 

Object Designer Create custom objects. Administrator
Developer
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Seing Functionality Roles

Message Templates Customize administrator notications,
 administrator emails, and contact emails.

Administrator

Access Control Access the Access Control editor to congure
sta and customer seings permissions for
Community Self Service.

Administrator
Supervisor
 

CP Promote Promote customer portal pages from the
staging area to the production area.

Administrator
Developer
 

CP Stage Copy customer portal development les to
the staging area.

Administrator
Developer
 

CP Edit Access the Customer Portal Administration
site and edit customer portal pages in the
development area using WebDAV.

Administrator
Developer
 

Rules View View business rules. Administrator
Supervisor
 
Sta member
 

Data Import Import data, including answers, contacts,
 incidents, organizations, and custom objects.

Administrator
Supervisor
 

Process Designer Create custom processes. Administrator
Developer
 
Supervisor
 
Sta member
 

Virtual Assistant Edit Access to conguration of the virtual
assistant.

Administrator

Broadcast Notications Send messages to other sta members. Administrator
Supervisor
 

Conguration Access to these areas and functionality:
• Password Conguration

• Conguration Seings

• Conguration Wizard

• Message Bases

• File Manager

• Interfaces

• Add-In Manager

• Email Address Sharing

Administrator

Business Process Seings Dene interface appearance and functionality,
 including:

• Navigation Sets

Administrator
Supervisor
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Seing Functionality Roles

• Customizable Menus

• Countries

• Products/Categories/Dispositions

• Standard Text

• Variables

• Holidays

• Product Catalog

• Price Schedules

• Tracked Link Categories

Rules Edit Edit business rules. Administrator
Supervisor
 

Proles Add and edit proles. Administrator

SSO Login (SAML 2.0) Allows login only through an identity provider,
that is, using a single sign-on process.
Oracle Service Cloud uses the SAML 2.0
protocol for single sign-on.
 

Administrator

Skill Edit Access to conguration of advanced routing. Administrator
Supervisor
 

Agent Browser User Interface Access to the Oracle Service Cloud using
the Agent Browser UI through account
authentication.

Administrator
Supervisor
 
Sta member
 

Public SOAP API Access the public SOAP API through account
or session authentication.

Administrator
Developer
 

Public Knowledge Foundation API Access the public Knowledge Foundation API
through account or session authentication.

Administrator
Developer
 
Supervisor
 
Sta member
 

Organizations

Add, edit, delete, and view organizations. Administrator

Edit and view organizations. Supervisor

View organizations. Sta member

Contacts

Add, edit, delete, view, and move contacts. Administrator

Add, email, edit, delete, and view contacts. Supervisor
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Seing Functionality Roles

Email, edit, and view contacts. Sta member

Service

Add, edit, view, and delete incidents; propose
incidents as answers; respond to incidents.

Administrator
Supervisor
 

Incidents

Add, edit, and respond to incidents. Sta member

Add, edit, and delete answers; set answers to
public status.

Administrator
Supervisor
 

Answers

Add and edit answers. Sta member

Add, edit, delete, and view assets. Administrator
Supervisor
 

Asset

View and edit assets. Sta member

Opportunities

Create, edit, delete, view, respond to leads,
 and send quotes.

Administrator

Create, edit, and view leads, and send quotes. Supervisor

View leads and send quotes. Sta member

Outreach

Create, edit, delete, and view mailings,
 campaigns, documents, templates, snippets,
 le aachments, tracked links, segments, and
contact lists.

Administrator

Edit and view mailings, campaigns,
 documents, templates, snippets, le
aachments, tracked links, segments, and
contact lists.

Supervisor

View mailings, campaigns, documents,
 templates, snippets, le aachments, tracked
links, segments, and contact lists.

Sta member

Feedback

Create, edit, delete, and view surveys,
 questions, documents, templates, snippets,
 le aachments, tracked links, segments, and
contact lists.

Administrator

Edit and view surveys, questions, documents,
 templates, snippets, le aachments, tracked
links, segments, and contact lists.

Supervisor

View surveys, questions, documents,
 templates, snippets, le aachments, tracked
links, segments, and contact lists.

Sta member
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Seing Functionality Roles

Tasks

Create, edit, delete, and view tasks. Administrator

Edit, view, and delete tasks. Supervisor

View tasks. Sta member

Analytics

Create, edit, view, customize, print, export,
 and forward reports.

Administrator

Edit, view, customize, print, export, and
forward reports.

Supervisor

View, edit, print, export, and forward reports. Sta member

Email Security  
Although most email sent over networks is not encrypted, we recommend encrypting all data that you deem sensitive.

Oracle Service Cloud is designed to prevent the inadvertent release of information, but there are also a number of
conguration seings related to email that you can use to increase your protection.

Certicates
Secure sockets layer (SSL) protocol provides encryption services for client-server communication security. To
accomplish this, digital certicates are used to convey identication information and encryption keys. Since all agent
desktop communication is over SSL, your site already uses a certicate issued by Oracle. This certicate can be used for
other secure communication links, including sta member and customer access and email. See Congure SSL Security
Seings, Congure SMIME Security Seings, and Certicate Validation Options.

For a discussion about the conguration seings you can use to protect your site and improve your security, see Site
Protection.

Emailing Links to Answers
You can email links to answers from the customer portal or the administration interface. If a login is required for
customers to access an answer, a user name and password will be required.

Answer visibility depends on who is trying to access the answer—a customer or a sta member—and where they are
accessing it from—the customer portal or the administration interface. From the customer portal, visibility is controlled
by a number of elds, including the Status eld, which is dened on the administration interface. For example, if an
answer status has been set to Private, then that answer is not visible to customers. See How to Control Answer Visibility.

For customers accessing answers from the customer portal, each answer link is protected by a security token with a
limited lifetime that is dened in the conguration seing SEC_EU_EMAIL_LINK_EXPIRE. The default value is eight
hours, meaning that a customer has eight hours to click the link and read the information published in the answer. We
recommend using this security token to limit the time answers are available to customers. Because aackers need time
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to build phishing sites (for luring a user into clicking a link), the smaller the window of time you allow for access to your
answers, the more secure your site will be.

For example, if an email with an answer link is copied by an aacker, access to the security token and the link has been
compromised. If your site requires customers to log in to see an answer, the answer itself is safe, but the aacker can
create a phishing scenario using a modied link that takes customers to an external site where their login credentials
are stolen. It takes time to accomplish this, so the shorter the window of opportunity, the lower the likelihood of success.
Seing the security token expiration in SEC_EU_EMAIL_LINK_EXPIRE helps discourage aackers. See How You Secure
Customer Passwords.

From the administration interface, prole permissions control sta members’ access to answers. Permissions of the sta
member who sends an email link to an answer do not transfer to the receiver, so data security is maintained.

Abuse Detection  
A potential threat to any website is a “denial of service” (DoS) aack where the aacker issues a large number of
requests for service. Perpetrators of DoS aacks typically target sites or services hosted on high-prole web servers
such as banks and credit card payment gateways.

DoS aacks can slow the response time to legitimate visitors, overwhelm the database server, and generate excessive
emails that interfere with normal operation. To prevent these aacks, Oracle Service Cloud provides web form and
survey security through CAPTCHA, which automatically requires human validation when abuse is suspected. CAPTCHA
validation is typically triggered only if there appears to be active abuse of a website. However, you can customize
CAPTCHA requirements from the customer portal. See Web Form and Survey Security and Web Form Security .

Related Topics
• Require CAPTCHA Validation on Submit

• Open CAPTCHA Within a Form

• Set the Abuse Detection Cookie

• Remove ClickjackPrevention from the Template

Overview of Security-Related Conguration Seings  
Certain conguration seings have a direct eect on security. Some aect the administration side of Oracle Service
Cloud and others aect the customer portal or an external website.

By making a conscious decision to determine the appropriate level of security that ts your business, you can dene
conguration seings to reect a suitable security level. Conguration seings that specically impact security are
detailed in the sections that follow. Paths to each seing in the Conguration Seings editor, descriptions, and default
values are also listed. Conguration seings in this section are grouped into these categories.

• Site protection

• Session data

• Password protection

• File aachment security
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• Chat security

• Social experience security

For a complete list of security-related conguration seings by security level and signicance, see Security Level.

Note:  Depending on your site’s conguration, some seings may be hidden. If you cannot nd a certain
conguration seing, contact your Oracle account manager.

Site Protection  
One of the most important steps you can take to protect your site is to limit access to the greatest extent possible while
still meeting the requirements of your sta members and customers.

By restricting access to your site or certain functionality within your site, you can reduce opportunities for unwanted
visitors with malicious intent to gain access to your assets. Conguration seing descriptions that aect your site’s
protection are listed in the following two tables.

Conguration Seing Description Default Value

Common/General/Security

SEC_VALID_ADMIN_HOSTS
 

Denes which hosts can access the
administration interface.
 

Blank

SEC_VALID_INTEG_HOSTS
 

Denes which hosts can access the
integration interface. Only sta members
who log in from the listed IP addresses,
 including network groups, can access the
API interface.
 

Blank

RightNow User Interface/General/Security

CLIENT_SESSION_EXP
 

Requires sta members to log in again
after a specied period of inactivity on
the Service Console. To reduce the risk
of a misappropriated agent session, we
recommend keeping the default value of
15.
 

Note:  This seing is not used
strictly for security. It is also
used in the desktop usage
administration feature.

15

RightNow User Interface/Tool Bar/General

LOGIN_SECURITY_MSG
 

Denes a message to display after sta
members click the Login buon on the
Login window.
 
You can use this seing to issue a security
statement, distribute terms of a use
agreement, or any login message you

Blank
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Conguration Seing Description Default Value

want sta members to agree to before the
Service Console opens.
 

Conguration Seing Description Default Value

Common/General/Security

CP_REDIRECT_HOSTS
 

Denes which hosts are allowed as
redirect targets from the customer portal.
The default seing (blank) prevents
all redirects outside of your interface
domain.
 
If you have more than one interface that
you need to redirect to, each interface
domain name must be specied in CP_
REDIRECT_HOSTS.
 

• Blank = Prevents all redirects outside
of your interface domain.

• * = Allows all redirects, including
redirects to external sites. (Not
recommended.)

Note:  Redirects within your
interface domain, as well as
hosts specied in related
conguration seings are
implicitly allowed. Therefore,
 those domains do not need to
be listed in the CP_REDIRECT_
HOSTS seing.

Blank

SEC_VALID_ENDUSER_ HOSTS
 

Note:  This seing applies only
to PHP pages. It does not block
access to static assets such
as URLs, images, JavaScript,
 folders, or les. For more
information, contact your Oracle
account manager.

Denes which hosts can access the
customer portal. Only customers coming
from a host in the valid list are allowed
access to the customer portal.
 

Tip:  The valid list is practical
only if the set of allowed hosts is
conned to 10 or fewer domains.

Blank

SEC_INVALID_ENDUSER_ HOSTS
 

Denes which hosts are not allowed
access to the customer portal. The invalid
list is used to prevent spiders from known
locations.

Blank
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Conguration Seing Description Default Value

 

RightNow User Interface/General/Security

SUBMIT_TOKEN_EXP
 

Denes the amount of time, in minutes,
 that the submit token used for token
verication is valid.
 

30

Clickjacking Protection  
Clickjacking is an aack on browser security that can mislead your customers into clicking a concealed link.

On a clickjacked page, aackers load another page in a transparent layer over your original page. Users think they are
clicking visible buons, while they are actually performing actions on the hidden page. The hidden page may even be an
authentic one, such as a page from a well-known, reputable business. This makes it possible for aackers to trick your
customers into performing unintended actions.

A common defense against clickjacking is to aempt to block the site you are trying to protect from being loaded into a
frame.

The ClickjackPrevention widget, included by default in the standard and mobile templates, ensures that your customer
portal cannot be viewed inside a frame or iFrame.

If you do not use frames, you can edit the standard.php le of your template le to minimize the risk of clickjacking. For
the complete procedure, see Remove ClickjackPrevention from the Template.

For more information on clickjacking, including denitions for X-Frame-Options response headers, search for the
Clickjacking Defense Cheat Sheet on the OWASP website.

Related Topics
• iFrame Security Issues

• Overview of the Customer Portal Standard Template

Cross-Site Request Forgery  
Cross-site request forgery (CSRF) causes a user’s browser to load pages (including forms) that typically require
authentication in an aempt to perform actions on behalf of the user.

If the user has a valid authenticated session for the site the aacker is causing to load into the browser, those requests
will succeed. If proper protections are not in place, this may let the aacker perform unintended actions on behalf of the
user.

Submit tokens ensure that the contact who opened the page is the only contact who can submit the form. The
SUBMIT_TOKEN_EXP conguration seing lets you dene the amount of time the submit token is valid and is set, by
default, to expire 30 minutes from the time the token was sent. After 30 minutes, the contact will receive a new token.
The expiration process is invisible to the contact making for a seamless user experience.
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For more information about CSRF vulnerabilities, search for the CSRF Prevention Cheat Sheet on the OWASP website.

Redirect Security  
Linking from one page to another is a security risk you should consider. For example, you may have placed a link in your
URL to redirect users to dierent locations within your site.

Typically, these are links to other les on your site but they can also be links to another interface, either on your site or
on an external site. Aackers can take advantage of redirects by creating URL links in these locations.

• Questions on your page

• Uploaded les

• Emails

In each of these scenarios, an aacker bets that users will click the link they create and be redirected to an external site
where data can be maliciously harvested.

To protect your site from this type of aack, you can set the value of CP_REDIRECT_HOSTS to a list of interface domains
that are legitimate redirect targets. The default value is blank, which limits redirects to pages only within your interface
domain. Keep in mind that redirects to domains specied in related conguration seings are implicitly allowed.

This table displays sample values for CP_REDIRECT_HOSTS.

Value Meaning

Blank
 

Prevents all redirects outside of your interface. (Default)
 

*
 

Allows all redirects. (Not recommended.)
 

*.example.com
 

Allows redirects to all sites in the example.com domain.
 

one.example.com, two.example.com
 

Allows redirects to sites one and two in the example.com domain.
 

example.custhelp.com, *.test.com
 

Allows redirects to example.custhelp.com and any interface in the test.com domain.
 

For information about securely publishing answer links on your site, see Email Security.

Session-Data Security  
To maintain state information about sta members and customers, we use session data that is passed between the sta
member’s or customer’s system and the web server.

When an individual is logged in, data from the session can provide the necessary authentication for accessing your data
that would not otherwise be available. Session data security prevents aacks that stem from the trust the system has in
authenticated users. Without session data security, aackers may be able to capture session data and reuse it. These are
commonly referred to as “replay” aacks or “man-in-the-middle” aacks.
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The SESSION_HARD_TIMEOUT conguration seing helps reduce session exploitation by forcing sta members to
reauthenticate after a specied period of time. Set to twelve hours by default, this seing creates a new session while
destroying the previous session each time the sta member reauthenticates. See How You Force Session Expiration.

The CP_FORCE_PASSWORDS_OVER_HTTPS conguration seing is enabled by default and helps protect sta
members and customers from malicious activity such as password theft. This seing requires that all login operations,
such as login name and password, be performed over HTTPS. Therefore, logged-in users interact entirely on HTTPS.

Note:  Pages that use passwords within standard widgets are automatically redirected to HTTPS.

If your site is password protected, you should require customers to log in to the customer portal. Even if only your
answer pages are password protected, the CP_CONTACT_LOGIN_REQUIRED conguration seing enforces secure
logon to your pages and controls on the customer portal. The CP_CONTACT_LOGIN_REQUIRED variable also prevents
unauthenticated chat sessions.

Oracle Service Cloud oers dierent session management schemes for the administration interface and the customer
portal. However, for both interfaces, we perform these actions:

• Encrypt session data stored in cookies.

• Set the Secure ag and the HTTP Only ag on cookies.

• Make session data dicult to use from a dierent computer system.

• Require sta members to reauthenticate after twelve hours. See the SESSION_HARD_TIMEOUT seing
description in the rst table.

• Require sta members to reauthenticate after a specied period of inactivity. See the CLIENT_SESSION_EXP
seing description in the rst table.

• Require all login operations to be performed over HTTPS. See the CP_FORCE_PASSWORDS_OVER_HTTPS
seing description in the second table.

Conguration seing descriptions that aect your site’s session data are listed in these tables.

Conguration Seing Description Default Value

RightNow User Interface/General/Security

CLIENT_SESSION_EXP Requires sta members to reauthenticate
after a specied period of inactivity on the
Service Console.
 

Note:  This seing is not used
strictly for security. It is also
used in the desktop usage
administration feature. See
Desktop Usage Control.

15 minutes

SESSION_HARD_TIMEOUT Requires sta members to reauthenticate
after a specied period of time.
 
This seing creates a new session each
time the sta member reauthenticates.
The previous session is destroyed.
 

12 hours
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Conguration Seing Description Default Value

RightNow User Interface/General/Security

CP_LOGIN_MAX_TIME Denes the time (in minutes) a customer
can be logged in without needing to log in
again. If a session goes past the dened
seing, the customer is required to log in
again.
 
The default is 0, which means that the
time is set by CP_LOGIN_COOKIE_EXP.
 

0

RightNow User Interface/Customer Portal/Login

CP_CONTACT_LOGIN_ REQUIRED Denes whether the customer portal
requires a customer to be logged in when
accessing most pages or controls.
 
Also prevents unauthenticated chat
sessions.
 

Note:  This seing does not
apply to the login, password
recovery, and account creation
pages, or pass-through
authentication (PTA). PTA is
described in the Pass-Through
Authentication Guide. If you do
not have this guide, contact your
Oracle account manager.

No

CP_COOKIES_ENABLED Denes whether the customer portal tries
to set cookies on a visitor’s browser.
 

Yes

CP_FORCE_PASSWORDS_ OVER_
HTTPS

Requires all login operations to be
performed over HTTPS.
 
Pages that use passwords within standard
widgets are automatically redirected to
HTTPS.
 

Yes

CP_LOGIN_COOKIE_EXP The time (in minutes) before the customer
portal login cookie expires. Set the value
to -1 if you want the cookie to expire when
the browser is closed. Set the value to 0 if
you never want the cookie to expire.
 

60

CP_MAX_LOGINS Denes the total number of concurrent
users that can be logged in to your support
site at any given time.
 
A value of 0 means there is no limit.
If you set a value for this seing, you
must also set a non-zero value for
CP_LOGIN_MAX_TIME.
 

0
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Conguration Seing Description Default Value

CP_MAX_LOGINS_PER_ CONTACT Denes the total number of active,
 concurrent logins a single user can be
logged in with. A value of 0 means there is
no limit.
 
If you set a value for this seing, you
must also set a non-zero value for
CP_LOGIN_MAX_TIME.
 

0

Password Protection  
No maer your security situation, you have considerable exibility in seing up passwords for your sta and your
customers.

If the data protected by a password is not critical or subject to privacy legislation, the default values in Oracle Service
Cloud may be acceptable. The most compromising dangers to passwords include:

• Password cracking by brute-force aack or an exhaustive key search.

• Nefarious activities, such as phishing and other social engineering aacks.

• Inadvertent release by users (sta members or customers) who write down their passwords, send them in
emails, or expose them to the public in other ways.

The choice of password controls depends on your security situation. For example, if users do not log in often, seing
password expiration parameters can result in unnecessary locked accounts and frustrated users. While locking accounts
can prevent some brute-force and denial-of-service aacks, it can also increase administrative overhead.

If you require your users to change their passwords regularly, you need to save history data to prevent reuse (at least
ve previous passwords). It is common for users to make a minor change to their password and eventually cycle back to
the original, so it is dicult to assess the value of this strategy.

If you are concerned that passwords could be compromised by poor user-handling (writing passwords down) or by
some form of aack, consider requiring regular changes. However, mandating frequent password changes in an
environment where they are strong and are not shared does not enhance security and may actually hamper it by
creating an environment that causes people to store passwords in electronic or wrien media.

No maer your security situation, you have considerable exibility in seing up passwords for your sta and your
customers. The topics in this section provide helpful information about your conguration options and identify tips for
conguring secure passwords throughout your system.

How You Congure Sta-Member Passwords  
You can strengthen passwords by dening requirements such as minimum password length, maximum number of
character repetitions and occurrences, and the minimum number of upper and lowercase characters, numbers, and
special characters allowed.

You congure passwords for your sta from the conguration list on the navigation pane ( Conguration >  Sta
Management > Password Conguration ).
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The options available to you in seing up password requirements can enhance security on your site as well as help
protect your customers’ information. This table describes the security benets of dening specic requirements for
passwords.

Password Conguration Security Benet

Number of Invalid Logins Locking accounts after a designated number of consecutive login failures makes it more dicult, but
not impossible, for aackers to use brute-force password cracking. If an aacker is able to obtain an
encrypted password, they can guess the algorithm used to encrypt it and simply run dierent strings
looking for a match. While time-consuming, current computing technology makes it possible to guess
up to - million passwords per second (and this number increases by 10 percent per year).
 
In Oracle Service Cloud, the default is 5 invalid login aempts before the account is locked.
 

Expiration Interval The password expiration interval helps mitigate risk for accounts that have been compromised or
accounts that have not been used for long periods of time. By seing a conservative value for the
number of days a password stays in eect, you can help lower the risk of aack. (Default = 90.)
 

Note:  PCI-compliance requires expiration interval to be 90 days or less.

Password Length While it is helpful to use case changes and special characters to enlarge the character set, enforcing
longer passwords is an easy way to improve password strength. (Default = 8.)
 
For example, if 76 characters are used randomly, it takes no more than 12 hours to crack a 6-character
password. Cracking time increases to 6 years for an 8-character password, and it would take 230
million years to crack a 12-character password. Of course, password cracking typically takes advantage
of the tendency to use common words in passwords so dictionary aacks can break passwords more
quickly.
 
For maximum security, even longer passwords (no less than 10 characters) are necessary. For example,
a 12-character password composed of 3 words from a 100,000 word dictionary could take more than
7 years to crack. Add a small amount of randomness to the password, and the cracking time rapidly
increases to 230 million years.
 

Numbers and Special Characters Requiring numbers and characters can add to the random factor of a password. They also make it
easier for a user to come up with a password that is easy to remember, but still unique. For example,
 MaryhaddaL1tlelam. (Default = 0.)
 

Uppercase and Lowercase Characters Requiring a mix of upper and lowercase characters can add to the random factor of a password. They
also make it easier for a user to come up with a password that is easy to remember, but still unique. For
example, 2BeOrNot2Bee?. (Default = 1.)
 

Number of Previous Passwords Password history prevents the repetition of passwords when a sta member changes a password
that is set to expire. Enforcing password expiration without seing the number of previous passwords
allowed makes password expiration less eective. We recommend allowing 6 to 10 previous passwords.
(Default = 10.)
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How You Secure Customer Passwords  
Conguration seings and password requirements enable you to secure customer passwords in Oracle Service Cloud.

Conguration Seings
The conguration seing EU_CUST_PASSWD_ENABLED controls the visibility of the Password eld on the customer
portal login window. This seing is enabled by default because it oers signicant protection for your organization and
your customers. However, if your organization does not require customer passwords, you can remove the Password
eld from the login window by disabling this seing.

Conguration Seing Description Default Value

Common/General/Security

SEC_EU_EMAIL_LINK_ EXPIRE Denes the duration in hours that a
temporary link to reset a customer’s
password is valid. This seing also denes
the length of time a customer has access
to answers on your site. See Emailing links
to answers in Email Security.
 

8

RightNow User Interface/General/End-User

EU_CUST_PASSWD_ ENABLED Displays the password eld on the
customer portal page.
 

Yes

Password Requirements
As with sta member passwords, you can dene requirements to strengthen passwords on your customer portal. The
editor for conguring customer passwords contains the same elds as those for sta passwords (see How You Congure
Sta-Member Passwords). The only dierences between the two editors are the default values.

See Dene Customer Password Requirements for the procedure to dene requirements for customers accessing your
customer portal.

How You Recover Forgoen Passwords  
Administrators must contact their Oracle account manager to recover forgoen password credentials. Other sta
members can recover both their user name and password by using the Oracle Service Cloud account self-service
feature.

You also can use this functionality as a tool to maintain the integrity of your organization’s login policies for all sta
members. Accessed by clicking Login Help on the Login window, the account self-service feature can be set up to
open the login procedure in online help or send sta an email if they have forgoen their user name or password. This
functionality is also available if your site has single sign-on (SSO) enabled. See Redirection to the Oracle Service Cloud
Login Page.
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This table describes the conguration seings for your forgoen-password options.

Conguration Seing Description Default Value

RightNow User Interface/Tool Bar/General

ACCT_RECOVER_STATUS Species the functionality of the Login
Help link on the Oracle Service Cloud
Login window. See Login Help Options.
 

• 0 = Opens the login procedure in
online help.

• 1 = Sends an email containing user
name or a link to the Password Reset
page for entering a new password
(default).

• 2 = Changes the email message sta
members receive when they click
Login Help. The alternate message is
dened in ACCT_RECOVER_ALT.

1

ACCT_RECOVER_ALT Species the alternate email message
to send when the conguration seing
ACCT_RECOVER_STATUS is set to 2.
 

Blank

Customers can also recover user names and passwords from the login window on the customer portal. See Change
the Open Login Options and Remove the Open Login Options. In both cases, if the password is forgoen, the correct
user name must be entered, and then a link to the Password Reset page is emailed to the address associated with
that user name. The password is reset when the link is sent and login is not allowed until the process is completed.
Customers must do this within the time frame contained in SEC_EU_EMAIL_LINK_EXPIRE. See How You Secure
Customer Passwords and Email Security.

How You Enforce Password Requirements  
After assessing your specic security situation, you may want to consider enforcing password requirements.

• Lock sta accounts after three to ve invalid login aempts. (The default is 5 in Oracle Service Cloud.)

• Set password length to a minimum of 10 characters.

• Require special characters and numbers.

• Require both uppercase and lowercase characters.

• Avoid using words or phrases that can be identied with a person, such as their name, address, telephone
number, job title, type of car, and so on.

• Encourage users to choose passwords that are easy to remember and to type. For example, common words,
song lyrics, poems and so on, with slightly misspelled words, go a long way toward security.

◦ 2BeOrNot2Bee?

◦ MaryhadaL1lelam

◦ JollyBARN+be4Cow
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• Stress the importance of keeping passwords secure by memorizing them and keeping them secret.

File-Aachment Security  
Aachments that Oracle Service Cloud allows for incidents, answers, community questions and comments, and features
that are used in mailings and surveys are a security concern because they can contain malicious code (malware) or data
that is part of an aack on your site.

All incoming aachments are scanned for malware, but you should always consider the possibility that aackers could
evade detection. Uploaded les containing HTML are a particular problem because they can provide links to sites that
can harvest private data from unsuspecting people. For example, an aacker could upload a le that appears to be a link
to an incident, but is actually a link to the aacker’s site, which prompts the receiver to enter user name and password
credentials.

Here are some guidelines to consider when working with aachments.

• Sta members should never follow a link unless they are condent that it is safe, and no data should ever be
entered to a linked site. If it is necessary to access a referenced site, instead of clicking a link, look at the web
address and verify that it goes where you think it should. Then type the correct web address into your browser.

• HTML les might contain executable code in the form of JavaScript or ActiveX controls that potentially can
have a signicant impact on your system. If browser security works properly, this should not happen.

• Browsers are one of the least secure types of software. You can disable some of this functionality, but you may
need it for many complex sites or applications, including Oracle Service Cloud. Therefore, be careful when
working with data from untrusted sources and educate your users about the risks associated with improper
handling of uploaded les.

As an additional precaution, you can prevent aachment viewing by requiring that users download le aachments
in order to be viewed. This protects the Oracle Service Cloud application as well as the associated data, and it also
allows additional levels of scanning to be applied. The conguration seing FATTACH_OPEN_ENABLED lets sta
members view aachments on the agent desktop. As a preventative measure, this seing is disabled. Disabling
FATTACH_OPEN_ENABLED does not change the display of aachments for customers, so aachments from external
sources can be veried as safe before they are placed in answers.

Even so, it is possible for a malicious user to create incidents with very large aachments that could be used to aack
site. To prevent this, the conguration seing FATTACH_MAX_SIZE controls the maximum allowable aachment. The
default (and the maximum allowable limit) is approximately twenty megabytes per aachment.

Note:  Regardless of the le-aachment limits you dene, le upload will fail if the upload takes more than ve
minutes.

To learn how to restrict the number of le aachments on the Ask a Question page, see Congure File Aachments.

This table describes conguration seings for le aachments.

Conguration Seing Description Default Value

RightNow User Interface/General/File Aach

FATTACH_MAX_SIZE Denes the maximum le size in bytes
that can be uploaded to the server as

20971520 (20
MB)
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Conguration Seing Description Default Value

an aachment. File upload will fail if the
upload takes more than ve minutes.
 

Tip:  Too much available
disk space can make your
site vulnerable to DoS
aacks. Consider the types
of aachments that will be
uploaded to your site, and then
set this value to as small as
practical for your needs. As far
as security goes, the more disk
space you can ll, the beer.

 
The maximum
allowable limit is
20 MB.
 

FATTACH_OPEN_ENABLED Lets sta members open le aachments
on the agent desktop.
 

No
 

Chat Security  
Oracle RightNow Chat Cloud Service (Chat) lets customers experience interactive, real-time conversations with agents.
There are a number of conguration options that protect these exchanges of information and the underlying services
that make them possible.

For complete details and procedures about conguring Chat see these topics:

• Chat for Agents

• Chat for Supervisors

• Chat for Customers

This table describes Chat conguration seings.

Conguration Seing Description Default Value

CHAT_WS_API_IP_HOST Denes the list of IP addresses and subnet
masks to make requests to the Chat API.
If this seing is enabled and left blank, all
hosts are allowed.
 
To enable this hidden seing and dene
your allowed IP addresses and subnet
masks, submit a service request on our
support site.
 

Blank

Common/General/Security

SEC_VALID_CHAT_API_HOSTS Denes which hosts and subnet masks of
hosts are allowed to access the Chat SOAP
interface from any chat-related request
coming from a customer to the server.
 

Blank
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Conguration Seing Description Default Value

Note:  If this seing is left blank,
 the server accepts requests from
all hosts.

CP_CONTACT_LOGIN_REQUIRED When enabled, enforces secure logon to
prevent unauthorized chat sessions.
 

No

Chat/General/Server

CHAT_CORS_WHITELIST Denes the list of origins allowed to make
cross-origin requests through the Chat
server.
 

Note:  If this seing is left blank,
 the server accepts requests from
all origins.

Blank

Chat/General/Create Incident

INC_PRIVATE_TRANSCRIPT_ ONLY Allows chat transcripts to be added to
incidents as private notes.
 

Note:  If enabled, customers
cannot see past chats.

No

Server Protection  
The Chat SOAP interface can be protected from potential threats by restricting access to valid chat servers.

The conguration seing SEC_VALID_CHAT_API_HOSTS denes the list of IP addresses and subnet masks specifying
the legal chat servers that are allowed to access the Chat SOAP interface. If this seing is left blank, all hosts are allowed.

Additionally, users can be protected from cross-origin resource sharing (CORS) aacks by dening the origins allowed
to make CORS requests in CHAT_CORS_WHITELIST. See “Cross-Origin Resource Sharing Protection” in Chat API
Protection.

Chat API Protection  
Oracle Service Cloud supports a Chat API that must be enabled by Oracle. When enabled, the API is protected by a
conguration seing that species the IP addresses and subnet masks to make requests to the Chat API. If this seing is
enabled and left blank, all hosts are allowed.
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Note:  Access to the Chat API is dened by the hidden conguration seing CHAT_WS_API_IP_HOST. To
enable this seing and specify the IP addresses and subnet masks you want to allow, submit a service request
on our support site.

User Protection
By enabling INC_PRIVATE_TRANSCRIPT_ONLY, you can change the privacy of the information in a Chat exchange.
Instead of being added to an incident as public information, it is added as a private note, which restricts access to the
data. If there is a chance that sta members will enter sensitive information during a chat session, this seing should be
enabled.

It is also possible to congure Chat to allow o-the-record chats in which the exchanged data is not recorded and can be
seen only in real time by the agent. See Congure Chaing O the Record.

Cross-Origin Resource Sharing Protection
Cross-origin resource sharing (CORS) lets client-side code make requests from one origin to another origin. This
functionality can be abused by an aacker to retrieve information from your site or to perform actions as a valid user.
You can protect your site from potential threats by restricting access to valid requests. The CHAT_CORS_WHITELIST
conguration seing denes the list of hosts or IP addresses allowed to make cross-origin domain requests. If this
seing is left blank, all origins are allowed.

Tip:  Keep in mind that restricting cross-origin resource sharing does not prevent cross-site request forgery
(CSRF). For information about CSRF protection, see Cross-Site Request Forgery and Social Experience Security.

For more information about testing for CORS vulnerabilities, search “Test cross origin resource sharing” on the OWASP
website.

External-Queue Security  
External chat queues allow sites outside of Oracle Service Cloud that use the Chat API to access Oracle Service Cloud
chat data.

Since external queues may be subject to more risk, we recommend allowing only those external queues that are
operationally necessary. To prevent potential misuse, you must add the chat queues that you deem acceptable from
the Chat Session Queue editor on the Customizable Menus page. Then, you must designate those queues for use
with third-party-initiated chat requests as external. Chat requests pre-routed to the external queues you dene will be
routed to agent desktops by an external routing system. The chat server and the external routing system exchange data
through the third-party queue API. See Add or Edit a Chat Session Queue.

Social Experience Security  
Oracle RightNow Social Experience (Social Experience) is your organization’s gateway to the social cloud and includes
three features.

• Channels

• Social Monitor
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• Self Service for Facebook

Related Topics
• Overview: Social Experience

Channel Security  
When providing service through social media, it is essential to maintain the security and condentiality of your
organization’s social account logins.

For this reason, Oracle Service Cloud lets you dene channel accounts, which are shared credentials that allow
designated agents to perform service functions through your social media accounts by securely storing the account
logins and passing authentication parameters on behalf of your agents. If you are currently providing service through
social media channels directly through the web, we strongly recommend considering the security benets of managing
those eorts within Oracle Service Cloud instead. See Social Channels.

When monitoring certain channel types, Oracle Service Cloud can store your customers’ social media user names in
their contact records. By tracking this identifying information, Oracle Service Cloud can associate incoming social
monitor incidents with contacts based on their social media accounts. However, unlike channel accounts, channel types
do not store passwords—they are used only to track the social identities of your customers across dierent services. See
How You Store Social Media User Names.

You may also want to consider SSL encryption options for social media services. Then trac between Oracle Service
Cloud and the social media site is encrypted. See Email Security.

Note:  Social Experience includes several APIs so you can access major social features from custom code. APIs
oer tremendous exibility, but it is important to recognize that accessing any part of Oracle Service Cloud
through an API moves a signicant part of the security responsibility to the external code.

Social Monitor Security  
There are opportunities to access external data and code from within Social Experience, such as Oracle RightNow Social
Monitor Cloud Service (Social Monitor).

Consequently, these features may not have the same level of security as Oracle Service Cloud and the exchange of data
may not be secure. Conguring your site in a high-security environment requires special care when implementing social
features.

Related Topics
• Overview of Social Monitor

Self Service for Facebook Authentication  
Oracle RightNow Self Service for Facebook Cloud Service (Self Service for Facebook) lets you embed a set of Oracle
Service Cloud service and community features directly on your organization’s Facebook page.
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After you create a Facebook page, you must enable Facebook on the Conguration Seings editor
(FACEBOOK_ENABLED). When the Self Service for Facebook application is installed on your Facebook page, it provides
two values—your application ID and your secret key. You must assign these values to their respective conguration
seings (FACEBOOK_APPLICATION_ID and FACEBOOK_APPLICATION_SECRET) in order to authenticate the link
between Facebook and Oracle Service Cloud. To ensure the integrity and security of your connection, you should keep
these values condential.

In addition, incidents can be created from your Facebook page. This functionality is enabled by default
(FACEBOOK_INCIDENTS_ENABLED) so your customers can submit questions without leaving Facebook. If you do not
want incidents to be created from your Facebook page, then you must disable this seing. See Open Login Credentials
for Social Accounts.

To learn more about Self Service for Facebook, see Overview of Self Service for Facebook.

Twier Security  
When you add Twier channel accounts, designated agents can respond to Twier messages publicly or privately from
the agent desktop.

Due to Twier’s unique functional design, we recommend that you encourage your customers to communicate privately
when resolving support issues through the Twier channel. Because your organization’s tweets can be read, reposted,
and replied to by any other Twier user, using public tweets to resolve sensitive service issues can be risky. For this
reason, it is vital that your agents follow the best practices for using Twier’s private messaging feature. See How You
Respond to Twier Posts.

If you prefer that all Twier searches be done securely over an SSL channel, contact your Oracle account manager.

Open Login Credentials for Social Accounts  
Oracle Service Cloud supports two open login standards, OAuth and OpenID. Both allow easy integration of sites that
support either one of those open login standards from the customer portal.

For details on the customer portal open login as it relates to Facebook and Twier, as well as other customer portal
login methods, see How Customers Log in to the Customer Portal. When your Facebook page or your Twier account is
created, they provide two values—your application ID and your secret key. To allow single sign-on, these values must be
assigned to their respective conguration seings in Oracle Service Cloud.

• FACEBOOK_OAUTH_APP_ID and FACEBOOK_OAUTH_APP_SECRET

• TWITTER_OAUTH_APP_ID and TWITTER_OAUTH_APP_SECRET

Conguration Seing Description Default Value

RightNow Common/3rd-Party Applications/Facebook

FACEBOOK_APPLICATION_ ID Species the Facebook application ID used
to host Facebook for Oracle Service Cloud.
 

Blank

FACEBOOK_APPLICATION_ SECRET Species the Facebook application secret
key used to host Facebook for Oracle

Blank
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Conguration Seing Description Default Value

Service Cloud. This seing is also used to
authenticate sta members and customers
who use Self Service for Facebook.
 

FACEBOOK_INCIDENTS_ ENABLED Lets customers and sta members create
private incidents from your Facebook
page.
 

Yes

RightNow User Interface/Open Login/OAuth Apps

FACEBOOK_OAUTH_APP_ID
 

Species the Facebook application ID
used to request the customer’s or sta
member’s credentials for open login with
Self Service for Facebook.
 

Blank

FACEBOOK_OAUTH_APP_ SECRET
 

Species the Facebook secret key used
to request the user’s credentials for open
login with Self Service for Facebook.
 

Blank

TWITTER_OAUTH_APP_ID
 

Species the Twier application ID used to
request the customer’s or sta member’s
credentials for open login with the Oracle
Service Cloud channel, Twier.
 

Blank

TWITTER_OAUTH_APP_ SECRET
 

Species the Twier secret key used to
request the customer’s or sta member’s
credentials for open login with the Oracle
Service Cloud channel, Twier.
 

Blank

Security Level  
This table describes conguration seings that you should consider using or seing to achieve your designated level of
security—high, medium, or low.

To make the seings easy to nd, the list is ordered alphabetically with each seing’s respective path on the
Conguration Seings editor.

Path/Conguration Seing For high-security
environment

For medium-
security
environment

For low-security
environment

Hidden

CHAT_WS_API_IP_HOST
 

Set to allowed IP addresses and subnet masks.
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Path/Conguration Seing For high-security
environment

For medium-
security
environment

For low-security
environment

Note:  To enable this hidden seing and dene your
allowed IP addresses and subnet masks, submit a
service request on our support site.

Chat/General/Server

CHAT_CORS_WHITELIST
 

Set to allowed
origins.
 

Set to allowed
origins.
 

Blank (default)
 

RightNow User Interface/General/Security

CLIENT_SESSION_EXP
 
This seing is also used in the desktop usage
administration feature.
 

15 (default)
 

16 to 45
 

0
 

RightNow User Interface/Customer Portal/Login

CP_CONTACT_LOGIN_REQUIRED
 

Yes
 

Yes
 

No (default)
 

CP_COOKIES_ENABLED
 

Yes (default) for all security environments.
 

CP_FORCE_PASSWORDS_OVER_ HTTPS
 

Yes (default)
 

Yes
 

Yes
 

CP_LOGIN_COOKIE_EXP
 

5 to 30
 

31 to 60 (default =
60)
 

-1
 

RightNow User Interface/General/Security

CP_LOGIN_MAX_TIME
 

As needed for all security environments (default = 0).
 

RightNow User Interface/Customer Portal/Login

CP_MAX_LOGINS
 
If you set a value for this seing, you must also
set a non-zero value for CP_LOGIN_MAX_TIME.
 

As needed for all security environments (default = 0).
 

CP_MAX_LOGINS_PER_CONTACT
 
If you set a value for this seing, you must also
set a non-zero value for CP_LOGIN_MAX_TIME.
 

0 (default)
 

0
 

0
 

Common/General/Security

CP_REDIRECT_HOSTS
 

As needed for all security environments (default = blank).
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Path/Conguration Seing For high-security
environment

For medium-
security
environment

For low-security
environment

RightNow User Interface/General/End-User

EU_CUST_PASSWD_ENABLED
 

Yes (default)
 

Yes (default)
 

No
 

RightNow Common/Service Modules/Oracle Email

EGW_PASSWD_CREATE
 

Yes (default)
 

Yes (default)
 

No
 

EGW_SECURE_UPDATE_MODE
 

2 (default)
 

2 (default)
 

1
 

RightNow Common/3rd-Party Applications/Facebook

FACEBOOK_INCIDENTS_ENABLED
 

No (default = Yes)
 

As needed.
 

As needed.
 

RightNow User Interface/Open Login/Oauth Apps

FACEBOOK_OAUTH_APP_ID
 

Facebook application ID for all security environments (if
Facebook is enabled).
 

FACEBOOK_OAUTH _APP_SECRET
 

Facebook secret key for all security environments (if Facebook is
enabled).
 

RightNow User Interface/General/File Aach

FATTACH_MAX_SIZE
 

Tip:  Consider the types of aachments
that will be uploaded to your site,
 and then set this value to allow the
minimum disk space that you need.
As far as security goes, the more disk
space you can ll, the beer.

As small as practical for your needs. Applies to all security
environments (default and maximum allowable limit = 20 MB).
 

Note:  File upload fails if the upload takes more than 5
minutes.

FATTACH_OPEN_ENABLED
 

No (default)
 

No
 

As needed.
 

Chat/General/Create Incident

INC_PRIVATE_TRANSCRIPT_ONLY
 

Yes
 

Yes
 

No (default)
 

LOGIN_SECURITY_MSG
 

As needed for all security environments (default = blank).
 

RightNow User Interface/Contact Services/Security

MYSEC_AUTO_CUST_CREATE
 

No (default = Yes)
 

No
 

As needed.
 

Common/General/Security
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Path/Conguration Seing For high-security
environment

For medium-
security
environment

For low-security
environment

SEC_BROWSER_USER_AGENT
 

Set to allowed user
agent strings.
 

Blank (default)
 

Blank (default)
 

SEC_EU_EMAIL_LINK_EXPIRE
 

8 (default)
 

12
 

24
 

SEC_INVALID_ENDUSER_HOSTS
 

Set to allowed IP
addresses.
 

Blank (default)
 

Blank (default)
 

SEC_INVALID_USER_AGENT
 

Set to user agent
strings that are not
allowed.
 

Blank (default)
 

Blank (default)
 

SEC_SPIDER_USER_AGENT
 

Set to list of known
web spider user
agent strings.
 

Blank (default)
 

Blank (default)
 

SEC_VALID_ADMIN_HOSTS
 

Set to allowed IP
addresses.
 

Set to allowed IP
addresses.
 

Blank (default)
 

SEC_VALID_CHAT_API_HOSTS
 

Set to allowed hosts and subnet masks for all security
environments (default = blank).
 

SEC_VALID_ENDUSER_HOSTS
 

Set to allowed IP
addresses.
 

Set to allowed IP
addresses.
 

Blank (default)
 

SEC_VALID_INTEG_HOSTS
 

Set to allowed IP
addresses.
 

Blank (default)
 

Blank (default)
 

SESSION_HARD_TIMEOUT
 

12 (default)
 

12-24
 

As needed.
 

RightNow User Interface/General/Security

SUBMIT_TOKEN_EXP
 

30 to 60 (default =
30)
 

30 to 300
 

30 to 1000
 

RightNow User Interface/Open Login/Oauth Apps/

TWITTER_OAUTH_APP_ID
 

Twier application ID for all security environments (if Twier is
enabled).
 

TWITTER_OAUTH_APP_SECRET
 

Twier secret key for all security environments (if Twier is
enabled).
 

Outreach and Feedback/General/Campaigns

WEBFORM_ID_BY_COOKIE_ DEFAULT As needed for all security environments (default = No).
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Path/Conguration Seing For high-security
environment

For medium-
security
environment

For low-security
environment

   

WEBFORM_ID_BY_LOGIN_ DEFAULT
 

As needed for all security environments (default = No).
 

WEBFORM_ID_BY_LOGIN_ REQUIRED_DEFAULT
 

As needed for all security environments (default = No).
 

WEBFORM_ID_BY_URL_PARAM_ DEFAULT
 

As needed.
 

As needed.
 

No (default)
 

WEBFORM_SET_COOKIE_DEFAULT
 

As needed.
 

As needed.
 

No (default)
 

RightNow User Interface/Customer Portal/Syndicated Widgets

WIDGET_INSTALLATION_HOSTS
 

As needed.
 

As needed.
 

Blank (default)
 

Related Topics
• Search for a Conguration Seing

• Edit a Conguration Seing

Security Signicance  
This table describes recommended security-related seings by signicance. They are grouped by high, medium, and
low in security signicance.

Signicance Conguration Seing Recommended Seing

CHAT_WS_API_IP_HOST
 

Set to allowed IP addresses and subnet masks.
 

Note:  To enable this hidden seing
and dene your allowed IP addresses
and subnet masks, submit a service
request on our support site.

CLIENT_SESSION_EXP
 

15
 
This seing is also used in the desktop usage
administration feature.

CP_FORCE_PASSWORDS_OVER_ HTTPS
 

Yes
 

High

CP_LOGIN_COOKIE_EXP
 

As needed.
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Signicance Conguration Seing Recommended Seing

CP_REDIRECT_HOSTS
 

Set to allowed hosts or leave default seing
(blank) to prevent all redirects outside of the
interface domain, including external sites.
 

EU_CUST_PASSWD_ENABLED
 

Yes
 

SEC_VALID_ADMIN_HOSTS
 

Set to allowed IP addresses.
 

SEC_VALID_CHAT_API_HOSTS
 

Set to allowed hosts and subnet masks.
 

SESSION_HARD_TIMEOUT
 

12
 

CHAT_CORS_WHITELIST
 

Set to allowed origins.
 

CP_CONTACT_LOGIN_REQUIRED
 

As needed.
 

CP_LOGIN_MAX_TIME
 

As needed.
 

EGW_PASSWD_CREATE
 

Yes
 

EGW_SECURE_UPDATE_MODE
 

2
 

FACEBOOK_INCIDENTS_ENABLED
 

Yes
 

FATTACH_OPEN_ENABLED
 

Yes
 

INC_PRIVATE_TRANSCRIPT_ONLY
 

Yes
 

SEC_EU_EMAIL_LINK_EXPIRE
 

8
 

SUBMIT_TOKEN_EXP
 

30
 

WEBFORM_ID_BY_COOKIE_ DEFAULT
 

As needed.
 

WEBFORM_ID_BY_LOGIN_ DEFAULT
 

As needed.
 

WEBFORM_ID_BY_LOGIN_ REQUIRED_
DEFAULT
 

As needed.
 

WEBFORM_ID_BY_URL_PARAM_ DEFAULT
 

As needed.
 

Medium

WEBFORM_SET_COOKIE_DEFAULT
 

As needed.
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Signicance Conguration Seing Recommended Seing

WIDGET_INSTALLATION_HOSTS
 

Set to allowed domain names.
 

CP_COOKIES_ENABLED
 

As needed.
 

CP_MAX_LOGINS
 

As needed.
 

CP_MAX_LOGINS_PER_CONTACT
 

As needed.
 

Note:  If you set a value for this
seing, you must also set a non-zero
value for CP_LOGIN_MAX_TIME.

FACEBOOK_OAUTH_APP_ID
 

As needed.
 

FACEBOOK_OAUTH _APP_SECRET
 

As needed.
 

FATTACH_MAX_SIZE
 

As small as practical for your needs.
 

Note:  Regardless of the le
aachment limits you dene, le
upload will fail if the upload takes
more than 5 minutes.

LOGIN_SECURITY_MSG
 

As needed.
 

MYSEC_AUTO_CUST_CREATE
 

As needed.
 

SEC_BROWSER_USER_AGENT
 

As needed.
 

SEC_INVALID_ENDUSER_HOSTS
 

As needed.
 

SEC_INVALID_USER_AGENT
 

As needed.
 

SEC_SPIDER_USER_AGENT
 

As needed.
 

SEC_VALID_ENDUSER_HOSTS
 

As needed.
 

SEC_VALID_INTEG_HOSTS
 

As needed.
 

TWITTER_OAUTH_APP_ID
 

As needed.
 

Low

TWITTER_OAUTH_APP_SECRET
 

As needed.
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Related Topics
• Search for a Conguration Seing

• Edit a Conguration Seing
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Glossary

absolute time  
An exact date and time dened in an escalation action for business rules or a comparison period for custom reports. In
standard reports, absolute time is the amount of time passed based on a 24-hour clock. See also relative time.

access level conditional section  
A method of controlling the visibility of a portion of an answer. Only those customers with permission to view the access
level assigned to the answer section can view it.

accessibility  
The characteristics of a website that allow all users, regardless of disability, to have complete access to the information
and features of the site.

account self-service  
A feature for sta members to get help when logging in to the administration interface. If sta members forget their
login information, they can request their user name or password by clicking Login Help on the Login window. Account
self-service can also be set up to open the login procedure in online help or to convey an alternate message.

action  
The part of a business rule that denes what happens when an object (answer, contact, incident, chat session,
opportunity, organization, target, or task) meets the rule’s conditions. Actions are also a part of script and workspace
rules, and a component of campaigns that can perform one of several functions.

action arrow  
An arrow on a workspace eld or control that displays available editing options.
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activate  
A process that is manually run after making changes to a state, function, or rule in a rule base to check for errors,
archive the current rule base, and convert the edited rule base to the active rule base. See business rules.

Active  
One of the default opportunity statuses and status types. An opportunity with the Active status is currently advancing in
the system toward a sale.

add-in  
A custom .NET component that is loaded and activated by Oracle Service Cloud to add new features and integration
capabilities.

Add-In Manager  
A utility for adding, updating, and deleting add-ins in Oracle Service Cloud. The Add-In Manager is also used to set add-
in permissions for each interface.

administration interface  
The graphical user interface that sta members use to congure and manage Oracle Service Cloud. See also agent
desktop and Service Console.

administrator  
A sta member who congures, customizes, and maintains an Oracle Service Cloud application.

administrator login  
The default login used by the administrator to download Oracle Service Cloud and log in the rst time. This special login
is not a dened sta account and has no navigation set or prole associated with it. Using this login, the administrator
must create a navigation set, prole, and sta account in order to access all functionality. See navigation set, prole, and
sta account.
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administration site  
See Customer Portal Administration site.

advanced mode  
A survey editing mode for creating detailed questionnaires using an extended feature set that includes survey
branching and automation elements.

Agedatabase  
A scheduled utility that operates on the knowledge base data to maintain dynamic answers and make searching more
ecient for sta members and customers.

agent  
A sta member who may be assigned incidents and chats with customers, and who may also maintain contact and
organization records.

agent desktop  
The graphical user interface that sta members use when working with records, mailings, surveys, campaigns, and
standard and custom reports. Agent desktop also refers to a set of complementary features in Oracle Service Cloud,
including workspaces, workspace rules, guides, agent scripts, script rules, workows, and add-ins, each representing a
dierent, powerful way of interacting with records in the knowledge base. While each component serves a distinct pur-
pose, they can be used together to create a highly adaptive work environment. See also administration interface and
Service Console.

agent scripting  
A feature that helps guide sta members as they enter information into records on workspaces. See also script.
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aging  
An automatic process that reduces an answer’s solved count as the frequency with which the answer is viewed by
customers declines. As the solved count is lowered, the answer will move down the list of answers and be less visible to
customers.

alias  
A word that represents another word or phrase. Aliases and the words or phrases they represent can be added to the
synonym list to enhance customer searching. See wordlist le.

anchor  
A node on an action or decision in a campaign used to create a path. Actions and decisions have anchors for incoming
and outgoing paths. Anchor also refers to a destination for hyperlinks placed at locations within documents for use in
mailings and questionnaires for surveys and in answers when linking to other answers.

answer  
Any knowledge base information that provides solutions to common customer support questions.

answer access level  
A method of controlling what information is visible to customers. The default answer access levels are Help and
Everyone, and custom access levels can be added.

answer custom eld  
A eld for gathering and displaying additional information about answers. Answer custom elds appear when adding or
editing an answer and on the Answers and answer details pages.

answer relationship  
The relationship between two or more related answers. Answer relationship types include sibling, manually related, and
learned link. Sibling and manually related answer relationships are dened by sta members. Learned link answers are
automatically dened through customer activity. See learned link, manually related answer, and sibling answer.
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answer status  
A method of controlling the visibility of an answer. The default answer statuses are Public, Private, Proposed, and
Review, and custom answer statuses can be added.

answer status type  
The status of an answer that determines whether it can be viewed by customers. The default answer status types are
Public and Private.

answer type  
The format in which answers are displayed to customers. Answer types include HTML, URL, and le aachment. See File
aachment answer, HTML answer, and URL answer.

answer update notication  
A way for customers to sign up to be notied whenever a particular answer is updated. Customers can also sign up for
notication whenever any answer associated with a specic product or category is updated.

Answers page  
A page on the customer portal where customers can view answers and search the knowledge base. Customers can view
individual answers or search the knowledge base using selection criteria to narrow their search. If additional elements
are enabled, customers can also search documents, websites, and communities. See also Web Indexer and Oracle
RightNow Social Experience communities.

API (application program interface)  
An interface that enables programmers to communicate with the Oracle database. The API includes functionality to
create, update, delete, and retrieve answers, contacts, hierarchical menus, incidents, opportunities, organizations,
quotes, SLA instances, sta accounts, and tasks.
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application menu  
An interface element containing a list of options for working in Oracle Service Cloud, including access to other areas
of the product and shortcuts for adding records and items to the knowledge base. The application menu also contains
options for changing personal seings and password and customizing the content pane and navigation pane display.
Sta members can also exit their application from this menu. See le menu.

Ask a Question  
A page on the customer portal where customers can submit a question when they cannot nd an answer in the
knowledge base.

asset  
Any product or service associated with an organization’s customers. Assets can require serial numbers or not and can be
registered by customers on the customer portal or by agents on the agent desktop.

asset product  
Any product or service sold or provided by an organization that can be tracked in Oracle Service Cloud. Asset products
are congured using the product catalog.

asset record  
Information about a specic product or service provided to a specic customer that is tracked and maintained in Oracle
Service Cloud.

audience  
All of the contacts belonging to the lists and segments associated with a mailing or survey. See also contact list and
segment.

audience sampling mode  
A market testing option for transactional mailings and surveys that sends a sample of test messages to portions of your
audience. If more than one message is created, market testing rotates through the test messages. See market testing.

1774



Oracle Service Cloud
Using Service Cloud

Glossary

audit log  
A list of all the actions performed on a report, record, or item in the knowledge base, including who performed the
action, what the action was, and the date and time of the action.

auto lter  
A control added to report columns for ltering report data by values in the columns.

automatic logout  
A way of managing desktop user sessions by automatically logging out inactive sessions after a specied time of
inactivity. Automatic logout is part of desktop usage administration, which assists organizations in lowering seat usage
for licensing compliance. See also force logout.

backup directory  
The directory that contains all the backup les created by the File Manager.

backup le  
A le that is automatically saved each time a le is edited through the File Manager. Before the le is overwrien, the
backup le is saved. The restore function can be used to revert to the backup le.

basic page set  
The template and set of customer portal pages that have been optimized for display on browsers with limited or no
JavaScript capabilities.

billable task  
A way of classifying and recording the amount of time agents spend working on incidents. The default billable task is
Miscellaneous, and custom billable tasks can be added.
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block  
A section of widget code that can be customized to extend the view of a standard widget. Widget code that is not within
a block cannot be modied.

block quotes  
A symbol or HTML tag that designates a section of text that is not part of the most current email reply, such as previous
entries in the email conversation. See also checksum and techmail.

boolean searching  
A knowledge base search that allows customers to connect multiple keywords using & (AND) and |(OR) operators.

bounced email  
Email that is undeliverable. Emails can be bounced when email accounts are not functioning properly or are full at the
time the mailing is sent. Outreach and Feedback tracks bounced emails. See also email management.

broadcast mailing  
A mailing sent to one or more contact lists or segments. Broadcast mailings can be sent at a scheduled time and can
also be used in campaigns.

broadcast survey  
A survey sent as a broadcast mailing in which the message, audience, and mailing options are dened in the survey.

builder  
A community member whose primary role is to create hives and groups for a community. Access to builder functions is
provided by the Builder–Custom and Builder–Template user types. See user type.
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Bulkdel  
A utility for deleting several incidents at once.

business objects  
The page of the Customer Portal Administration site that denes the set of answer, contact, and incident elds that can
be used to dene input and output elds on the customer portal.

business rules  
A component for dening processes to automate workow, notication, and escalation. Business rules can
automatically route incidents, opportunities, and chat sessions; send email and Outreach messages; escalate answers,
incidents, opportunities, and tasks; update records; assigns SLAs; and create Oer Advisor targets. See also script rules,
target rules, and workspace rules.

cached data  
Report data that has been temporarily stored in the database for quicker report generation. This data is cached nightly
by the Agedatabase utility and can be purged regularly. Cached data also refers to local cache les stored on a sta
member’s workstation. This includes all option lists data (any data accessed from a drop-down menu or menu list such
as customizable menu items) plus additional data such as report and workspace denitions, questions, documents, and
standard text.

Campaign  
A multiple-step marketing process based on business logic. Campaigns can contain any number of actions and
decisions and move contacts through a series of steps when specied criteria have been met.

Canceled  
A mailing and survey status that indicates a mailing or survey has been manually canceled before being completed.
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case section  
A logical group of conditional sections where one, and only one, conditional section displays to the customer. As soon
as the rst conditional section is matched, the content for that conditional section is added, and no other conditional
sections within the case section are evaluated. Case sections make content more relevant and targeted to a specic
audience than independent conditional statements. See also condition.

Case statement  
A type of conditional element used for multiple-choice decisions that allows more diverse branching capabilities to be
added to campaigns and surveys based on conditions dened in the workow. Case statements are unique because
they have an outgoing path for every condition. As soon as the rst choice (condition) is matched, the path for that
choice is followed, and no other conditions within the case statement are evaluated.

category  
An option for grouping answers and incidents that allows more precise organization in the knowledge base. Sta
members can classify answers and incidents by category and up to ve additional levels of sub-categories, allowing
more rened searching by customers and sta members. See also product.

category page  
A custom page that serves as a landing page for grouping and accessing custom content pages in a community.

certicate  
A digital piece of information for email and Internet security that includes the name of the certication authority, the
holder of the certicate, the certicate holder’s public key, the dates the certicate is valid, the serial number, and the
digital signature of the certication authority. Certicates are also called public and public key certicates.

certicate revocation list  
A list of certicates that have been suspended or revoked before they have expired. The certication authority
maintains, updates, and publishes the certicate revocation list at regular intervals.

1778



Oracle Service Cloud
Using Service Cloud

Glossary

certication authority  
A third party authorized to issue certicates and authenticate the identity of the holder of the certicate.

channel  
The source of an incoming incident or outgoing response. Channels are grouped as standard email channels (Service
Email, Outreach Email, Phone, Fax, Post, Service Web, Outreach Web, Chat, and Email) and social channels (Community,
Twier, YouTube, RSS feeds, and Facebook). Channels are also used to indicate contact, opportunity, and organization
notes.

channel account  
A shared credential that permits one or more designated sta accounts to pass through a social media site when login
and password authentication is required. Channel accounts can be created for communities, Facebook, and Twier.

channel type  
The social channels tracked in contact records when storing social account user names and associating social monitor
incidents to contacts. Channel types include Facebook, Twier, and YouTube.

chart style  
A collection of display seings that can quickly be applied to charts used in reports. Chart styles control most of the
graphical conguration of charts.

chat agent status  
A method of tracking an agent’s availability to chat. The default chat agent statuses are Unrestricted, Unqualied,
Unspecied, In Meeting, and On Break, and custom statuses can be added.

chat agent status type  
The status of an agent’s availability to chat. Default chat agent status types are Available, Unavailable, and Logged Out.

1779



Oracle Service Cloud
Using Service Cloud

Glossary

chat session  
A real-time, two-way dialog between a customer and one or more chat agents. See Oracle RightNow Chat Cloud Service.

chat session queue  
A sequence of unassigned requests for chat sessions. The default chat session queue is Default Chat Queue, and
custom queues can be added. Requests are added to chat session queues automatically by business rules.

chat session routing  
A process of routing customer requests for a chat to a specic chat session queue based on rules in the Chat rule base.

checksum  
A calculated value that represents the content of a block of quoted text. This value is sent within the block quote tags of
the email message and is used to determine if text has been added to the original message. See also techmail.

choice question  
A question type that allows customers to choose their answer from a menu, option, check box, or list.

Click-Once installer  
A utility used to install the Oracle Service Cloud Smart Client on sta members’ workstations.

client  
The interface that displays on a customer’s computer when submiing a request to chat with an agent.

clone  
To create an exact copy of an existing site or interface.
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Closed  
One of the default opportunity statuses and status types. An opportunity with the Closed status has resulted in a sale.

cloud search  
A search of social networking sites in order to track customer reaction to an organization’s products, services, and
overall reputation. In addition to searching the social cloud, sta members can schedule cloud searches, ignore or
respond to posts, and create incidents from posts.

clustering  
An automatic process that groups the knowledge base into clusters of related answers and labels each cluster group
with keywords that dene those answers. See also data mining and topic browsing.

cobrowse  
A feature in Chat that enables agents to guide customers through web pages using their mouse or other pointing device
to demonstrate actions. Cobrowsing may also be available on incident workspaces to let customers share their desktop
with agents when they are on the phone.

Code Assistant  
A Customer Portal tool to aid migration of custom code from earlier framework versions to a newer version. The tool
oers code suggestions for migrating widgets, converting to a new UI version, and removing features that are no longer
supported.

color scheme  
A collection of colors that can be applied to chart styles. Multiple colors can be dened and combined into one color
scheme. Charts that use the same scheme use the same set of colors.

comment  
A form of content created by members when responding to posts in a community.
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community  
A social web solution consisting of customizable hives, members, groups, and custom pages.

community privacy level  
The level of privacy that determines whether a login is required to access community content.

comparison period  
A reporting parameter used to compare a report’s time period to an identical length of time in the past. Comparison
periods are dened when creating or editing a custom report and can be included in standard reports.

compatibility set  
A set of Customer Portal widgets designed to be used together. Best practice recommends using widgets from the same
compatibility set on any given customer portal page rather than combining them from dierent compatibility sets.

competitor  
An option for identifying other parties pursuing the same opportunity.

compile  
A process that runs the compiler engine to check states, functions, and rules within a rule base to ensure there are no
errors. See activate.

Completed  
A mailing and survey status that indicates a broadcast mailing or broadcast survey has been sent. The system
automatically sets the status to Completed from the Sending status.
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complex expression  
A search technique that enables customers and sta to search for a broader set of content. This technique allows
wildcard searching using an asterisk (*) at the end of a word or partial word and a tilde (~) before a word to perform a
similar phrases search on that word only. Word stemming and logical operators are also supported. This technique is
available on the administration interface and the customer portal.

computed eld  
A column whose value is derived from calculations performed on database elds. Computed elds can be added to
output levels in custom reports.

condition  
The part of a business rule that determines whether an answer, contact, incident, chat session, opportunity,
organization, target, or task matches a business rule. Rules can contain multiple conditions. Conditions are also a part of
script and workspace rules.

conditional formaing  
A method of highlighting specic information in report columns that does not require creating data exceptions.

conditional section  
A section of text in a document that appears only to those contacts meeting certain criteria. Conditional sections can
also be placed in answers and tagged with specic answer access levels. In message templates, conditional sections can
be used to lter content by contact, prole, runtime variable, or record type. See also access level conditional section.

conference  
A feature in Chat that enables an agent to conference another agent into a chat session with a customer.
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conguration buon  
The buon in a sta member’s navigation set containing a list of all the conguration items necessary to congure and
customize an organization’s application. Items can be added to or removed from this buon from the Navigation Sets
editor or, with the Customize Navigation Sets prole permission, the Customize List window. See also conguration list.

Conguration Seings editor  
The interface element used to customize the functionality and features of the administration interface and the customer
portal.

conguration list  
All of the conguration items associated with the conguration buon in a sta member’s navigation set. The
conguration list is organized in a tree on the navigation pane.

conguration seings  
All of the seings accessed from the Conguration Seings editor to congure and customize the administration
interface and the customer portal in Oracle Service Cloud.

Conguration Wizard  
An interactive utility for conguring web indexing on the customer portal. Web indexing allows customers to search
the knowledge base along with web pages and other web-accessible documents within a specied domain. See Web
Indexer.

Connect Object Explorer  
A ROQL query interface that helps Customer Portal developers become familiar with the Connect for PHP API and
explore Connect objects and metadata.

contact  
Any individual with a contact record in the knowledge base. Contact records can be added by sta members on the
Service Console and by customers on the customer portal. Contact records are also added automatically when a
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customer without a record submits a question on the Ask a Question page of the customer portal. See also primary
contact.

contact custom eld  
A eld for gathering and displaying additional information about contacts. Contact custom elds appear when adding
or editing a contact record and on the Your Account page of the customer portal.

contact list  
A static or xed group of contacts that is used to choose the contacts who receive a broadcast mailing or survey.
Contacts can be added to lists.

contact role  
An option for classifying contacts by their roles in opportunities.

contact type  
An option for classifying contacts by types, such as job positions or decision-making roles.

Content Library  
A component for creating content that can be used in mailings, web pages, and surveys. Content includes documents,
tracked links, les, templates, and snippets.

content page  
A type of custom page to which community content and functions can be added using panels. See also category page.

content pane  
The area on the console where sta members work with items selected from the navigation pane or the application
menu.

1785



Oracle Service Cloud
Using Service Cloud

Glossary

content pane tabs  
An interface element for switching between the items currently open on the Service Console. Content pane tabs display
at the top of the content pane by default. Sta members can click a tab to return to a report or item or right-click a tab
and select from a number of options.

context-sensitive answers  
A subset of SmartAssistant that allows organizations to construct special Related Answer links from any web page to
provide additional information to their customers. See also help access level.

control  
A tool for placing titles, spacers, reports, and other advanced features on a workspace.

cross tab  
A method of displaying report data in a table format.

CSV (comma-separated value)  
A le format with commas separating one column value from the next. Each row is delineated by a hard return. Also
called comma-delimited.

cultures  
A predened set of aributes, such as decimal symbols and display formats, used to populate elds on the Currencies
editor. Cultures are comparable to regions in Microsoft Windows. See also Currency.

Currency  
A monetary denotation based on country of origin. Currencies can be dened for each country or province in which an
organization does business. See also Exchange rate.
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custom eld  
A eld for gathering and displaying additional information about answers, contacts, incidents, opportunities,
organizations, quotes, sales products, sta accounts, and tasks. Custom elds appear when adding and editing records.
Depending on the type and visibility, they may also appear on the customer portal.

custom object  
Any custom table created or managed from the object designer. Custom objects can be added to Oracle Service Cloud
to integrate organization-specic data with the database. Although custom objects are not native to Oracle Service
Cloud, they can be tied to standard objects and added to workspaces, workows, custom reports, and navigation sets.
See also object and Oracle Service Cloud standard object.

custom page  
A category or content page that can be fully customized to extend areas of a community in need of additional resources
or exposition. See category page and content page.

custom report  
A report that is created by copying and editing one of the standard reports in Oracle Service Cloud and saving it as
a new report, or by combining data from selected tables in the database to create a new report. Custom reports can
include customized output, data computation, and scheduling. See also standard reports.

customer  
A contact or organization that has a service or purchase history in the knowledge base.

customer account  
Information consisting of a user ID and password that allows customers to access certain functions on the customer
portal, such as the Account Overview page. Customers can create an account by clicking the Sign Up link or the Your
Account tab on the customer portal. Customer accounts are also automatically created when a customer without an
account submits a question, which adds a contact record to the knowledge base.
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Customer Portal Administration site  
The site where administrative tasks, such as selecting the page set, viewing widget denitions and logs, and dening
page set mapping, are performed.

dashboard  
Any combination of individual reports shown together in one report. Using dashboards, sta members can search for
and view a wide range of data from dierent reports without opening each report individually. The customer portal also
includes a dashboard on the Customer Portal Administration site.

data dictionary  
A list of all the tables in the Oracle database that can be accessed from the Service Console. Data dictionary also refers
to the list of available tables and elds that can be used in custom reports and is accessed from the report designer.
Functions, output variables, and computed elds can also be selected from the data dictionary when working with a
custom report.

data import template  
A saved format used by the Data Import Wizard to map columns in a CSV le to columns in the database. See Data
Import Wizard.

Data Import Wizard  
An interactive utility used for importing records into the database.

data lifecycle management  
Provides built-in policies to archive and purge unused or unrequired data automatically and periodically.

data mining  
The exploration and analysis of large quantities of data to discover meaningful paerns and rules. Data mining enables
organizations to turn raw data into information they can use to gain a marketplace advantage.
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data set  
The database tables and table joins that determine what data can be returned in a report. Data set also consists of the
database columns a segment (dynamic list in Outreach and Feedback) will have access to and what lters will be used to
determine the nal data set.

data type  
A set of data having predened characteristics such as strings, integers, or dates. Each column in a database table is
assigned a data type. Data type also refers to the type of custom eld specied when adding answer, contact, incident,
opportunity, organization, quote, sales product, sta account, and task custom elds. Data types for custom elds
consist of menu, radio, integer, date, date/time, text eld, and text area elds.

database  
The tables that store information that is retrieved, edited, and added in an Oracle Service Cloud application. See also
data dictionary.

Dbaudit  
A utility that builds and populates the schema and performs the database portion of the Oracle Service Cloud update.
Dbaudit can also be used to view the database schema.

Dbstatus  
A scheduled utility that escalates incidents, answers, tasks, and opportunities based on business rules. Dbstatus also
sends emails to those customers who have requested to be notied when a particular answer has been updated, and
processes private Twier messages for the social monitor. See Answer update notication, Business rules, and Social
monitor.

Dead  
One of the default opportunity statuses and status types. An opportunity with the Dead status is no longer being
pursued by a sales representative.
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decision  
A component of a campaign. Decisions lter contacts by specied criteria and can have Yes and No paths.

decryption  
The process of converting encrypted text into readable text using private keys assigned to authorized persons.

default directory  
The directory containing original default copies of all the les customizable through the File Manager. During an
update, any les that have changed will also be updated in the default directory. Using the restore function, a le can be
restored to the original conguration. See File Manager.

deliverability  
The degree to which an email message aligns with industry-accepted practices to ensure delivery to an intended
recipient. Emails with low deliverability are often blocked by ISPs and spam lters.

dependency  
A relationship or association between items in the database in which the use of one item impacts the functionality of
the other item. When a dependent item is deleted, such as deleting a contact list used in a mailing, all items that use the
dependent item become invalid and must be manually updated.

deploy  
To stage customer portal pages from the development folder and then promote the staged les into production. See
also stage and promote.

deployment log  
The record of actions taken on customer portal les, including staging, promoting, rolling back, and updating through
upgrades and service packs.
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deprecated  
A condition that indicates a feature or widget has been replaced with dierent functionality or a newer widget.

design space  
The section of the workspace designer where elds and controls are added, edited, moved, and removed to create a
workspace.

desktop usage administration  
Functionality for managing desktop user sessions to help organizations lower seat usage for licensing compliance and
reduce costs. The administrator can manage both active and inactive sessions using force logout and automatic logout
options. See automatic logout and force logout.

desktop workow  
A sequence of workspaces, scripts, decisions, and actions presented to sta members as a dynamic interface to support
complex business processes.

development area  
The set of customer portal les that can be edited and viewed without being available to customers. Designers and
developers can work on these les and test their changes until they are satised that the les can be made publicly
available to their customers, at which point the development les are staged and promoted to the production area. See
also production area.

display position  
The position where a new answer appears on the Answers page. Options include Historical Usefulness; Place at Top,
Middle, or Boom; Fix at Top, Middle, or Boom. The display position is selected from the answer’s Display Position
drop-down menu.
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disposition  
An option for classifying and recording how incidents are ultimately resolved. Up to six levels of dispositions are
available.

distribution list  
A mailing list of non-sta member email addresses used for scheduling reports or any mailing event.

docked lter  
A runtime selectable lter or output variable that is added to the top of a report. Docked lters let report users select
dierent runtime lter values and output variables in the report, bypassing the Search window.

document  
The material used in a survey or mailing, or served as a web page that can contain text, snippets, conditional sections
based on contact lters, merge elds, links, and web forms.

DomainKeys (DK)  
A form of email authentication that uses a cryptographic signature to verify that an email message originated from a
specic organization. DomainKeys diers from DKIM authentication primarily by the email headers used to generate the
signature.

DomainKeys Identied Mail (DKIM)  
A form of email authentication that uses a cryptographic signature to verify that an email message originated from a
specic organization. DKIM diers from DomainKeys authentication primarily by the email headers used to generate the
signature.

dormant incident  
An incident that is not returned when performing word- or phrase-based searches. After remaining in the Solved status
for a specied time, incidents become dormant to ensure that the knowledge base is populated with the most useful
and timely information.
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Draft  
The preliminary status of a mailing or survey. When a mailing or survey is created, it is set to the Draft status. The status
will also return to Draft if the mailing or survey’s schedule is canceled.

drill down  
To start at a top or general level and become more specic at each lower level. The drill-down feature enables access to
additional output levels in reports.

drill-down lter  
The elds in an output level used to lter the data returned when drilling down to another output level. This impacts
what data is returned in the drill-down level.

drill-down link  
The eld in an output level that is used as a link to drill down to the next output level.

dynamic form  
A form that hides or displays elds based on a customer’s response to other elds on the form.

editor  
A layout format on the content pane when working with records and conguration items. Editors contain the elds for
adding and editing records and items.

Else clause  
The clause that follows the Then clause of a business rule. If the conditions of a rule are met, the actions in the Then
clause are invoked. If the rule’s conditions are not met, the actions in the Else clause are invoked.
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email address sharing  
Functionality that allows a single email address to be shared by multiple contacts, such as members of a family or team.
When enabled, a contact-matching process is used to associate records and transactions initiated by a shared email
address.

email answer  
A feature that enables customers to email answers they are viewing to a specic email address.

email management  
Functionality that sends and receives email messages, processes bounced messages, intelligently routes incoming
inquiries based on business rules, and automatically suggests answers to inquiries.

email message  
An email that is automatically sent to customers or sta members. The process of sending email messages is triggered
by events in Oracle Service Cloud. For instance, when a customer submits a question, the Question Receipt message
will be sent to the customer’s email address. Using the Message Templates editor, sta members can customize each
message and standardize their design to give them all the same look and feel. See message templates and Global
template.

encryption  
The process of translating a text message into unreadable text to ensure security. Encrypted messages may be read
only by authorized persons with access to a private key that allows them to convert the message back into readable text.

escalation  
A means of tracking answers, incidents, opportunities, and tasks using business rules. When a rule’s conditions are met,
the rules engine schedules escalation to the new level. When the scheduled time (based on absolute or relative time)
arrives, the rules engine sets the escalation level and takes the action specied by the rule, such as sending an email,
notifying a manager, or following up with a customer. See business rules.
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even split mode  
A market testing option for broadcast mailings and surveys that sends test messages to equal portions of an audience.
See market testing.

event (Named/Exit/Finish)  
An action dened in a script rule or workspace rule that can be used to trigger other rules or workow connectors.
Events are dened by adding event re actions, such as the Fire a Named Event action.

Everyone access level  
An access level designed to allow answers to be visible to all customers depending on the answer status.

exception  
A method of highlighting report data that meets certain criteria. Data exceptions also allow email alerts to be sent when
data in a scheduled report meets the exception criteria.

exchange rate  
A scale of monetary conversion from one currency to another. See Currency.

explorer  
A layout format on the content pane that displays a tree on the left, containing folders and other items, and a detailed
list of the selected folder’s contents (subfolders and les) on the right. Explorers are available for certain conguration
items and components in Oracle Service Cloud.

expression  
A component of xed and runtime selectable lters that denes a function, database column, value, or any combination
of the three.
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extend  
Using the widget builder to create a new widget by modifying the behavior and aributes of an existing widget.

external event  
A program or script that runs as the result of an event occurring in Oracle Service Cloud, an action specied in a
business rule, or an action in a marketing campaign.

external suppression list  
An email delivery lter used to exclude an explicit set of email addresses from all mailings and surveys. When a mailing
or survey is launched, contacts with email addresses in the list are ltered from the audience by default.

FCRR (rst contact resolution rate)  
A statistic that reports how often sta members or groups solve incidents with only one response. This number is
displayed as the percentage of incidents solved with only one sta response.

le  
A le that is uploaded to Outreach for aaching as a link in a document or snippet. From the Content Library, les can
be uploaded and their characteristics can be dened.

le aachment  
A le that is aached to an answer, contact, incident, opportunity, organization, or task, or sent with an incident
response or quote. Files that are permanently aached to an incident or answer can be viewed by customers who view
the record. Files that are sent with an incident response can be opened with the customer’s email client and are not
permanently aached to the record.

le aachment answer  
A type of answer that appears as a le aachment.
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le link  
A clickable link to a le aachment that is inserted in a snippet or a document.

File Manager  
The interface used to modify les for Oracle Service Cloud products. Administrators can modify les used to customize
a site’s Chat images, custom scripts, wordlist les, dictionary les, and certicate directories.

File menu  
The interface element used to access the application menu. The File menu is located to the left of the Home tab on the
ribbon. See also application menu.

nal message  
A mailing format used to send the mailing as nal. In broadcast mailings and surveys, nal messages are sent to all
audience members who have not yet received a test message.

rst due  
A queuing pull policy that uses the incident due date or longest wait to determine which incidents or chats to retrieve
from the queue.

xed lter  
A component of Analytics and Outreach and Feedback segments used to dene the data set available in the report or
segment. Fixed lters are statements constructed from expressions, functions, and operators, and cannot be altered
when using a segment or when running a report. See also custom report and segment.

ag  
A method for dening the priority of a record. A ag displays at the top of records and sta members can add text to
the ag and change the ag importance (red=high, blue=medium, green=low, white=no importance).
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ow diagram  
A graphical representation of a campaign, survey, or desktop workow. Flow diagrams allow sta members to diagram
the events and decisions of a campaign, survey, or business process. When a campaign or survey is launched, contacts
are automatically moved through the ow based on the specied criteria. When a desktop workow is associated with
a record editor in a prole, sta members with that prole will move through the ow when opening a record of the
corresponding type. See also desktop workow.

force logout  
A way of managing desktop user sessions by manually logging out sta accounts who are currently logged in. Force
logout is part of desktop usage administration, which assists organizations in lowering seat usage for licensing
compliance. See also automatic logout and desktop usage administration.

forecast  
A projection of revenue for an opportunity that may close in a given sales period.

foreign key  
A column or columns that contain values found in a primary key of another table. Foreign keys are used to ensure
relational integrity and are rarely primary keys. See also primary key.

Forward to Friend link  
A link that enables contacts to forward the message to another email address. This type of link can be added to
documents, templates, and snippets for use in mailings, surveys, or web pages.

framework  
The underlying code structure of the Customer Portal, which oers a standard reference implementation as well as the
ability to customize code for particular applications.
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function  
A mathematical operator that can be applied to data from database elds to modify the data that is returned in an
output column. Function also refers to a container for business rules. Functions are used anywhere in a business
process that dictates doing the same thing in more than one place. Functions reduce the number of rules needed by
allowing the same rules to be evaluated from multiple states. See also business rules and rule state.

Give Feedback  
A link on the sidebar on the Customer Portal template that customers can click to submit feedback about an
organization’s website, customer service, or product satisfaction.

Global header  
The global header, located at the top of the Agent Browser ui, contains options for working in oracle service cloud.

Global template  
An element of message templates functionality containing the content that frames the message-specic content
in each system-generated notication and email message. The global template is used to standardize the design of
outgoing messages to give them the same look and feel. See message templates.

group  
A way to organize sta accounts in Oracle Service Cloud. In communities, group refers to a collection of members based
on a common interest, cause, or organization.

group type  
A classication used to organize groups in a community and expand searching of related members and content.

grouping  
A method for grouping data in a segment. Filters can be used when grouping and are applied to the data after the
grouping is completed.
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guest  
Any community visitor who is not logged in with a community account.

guide  
A collection of branching questions, responses, answers, and text explanations used in guided assistance. Guide also
refers to information about a promotion generated by a marketing sta member. This information appears on the Oer
Advisor window to help agents present the promotion to customers. See guided assistance and Oer Advisor.

guided assistance  
A component that helps agents quickly locate answers and text explanations using branching questions to guide them
to the answers they need. The answers and explanations agents nd can be sent to customers in incident responses or
relayed to customers over the phone. Guides can also be made available to customers on the customer portal to help
them nd their own answers to questions.

hash  
A ten-digit alphanumeric string used to identify a specic hive, page, group, or member for certain community
functions.

help access level  
An answer access level for context-sensitive answers. Help answers are not visible to customers except through special
hyperlinks. See context-sensitive answers.

Hosting Management System (HMS)  
An application used to manage a Service Cloud update. It manages scheduling and notications, and includes checklists
of tasks that must be performed prior to and following an update to a new release.

hive  
A resource entity, such as a blog or message board, used by community members to communicate about a central topic,
theme, or goal. Hives are sometimes referred to as resources.
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hive permissions  
The set of permissions that allow members to perform specic actions in the hive, such as adding members, posting
content, or commenting on posts.

hive privacy level  
The hive access status determined by the community privacy level and hive permissions. See community privacy level
and hive permissions.

hive template  
A hive that is set to the Template status, making it accessible as a design template but not editable or searchable by the
community. See also hive.

hive type  
A classication used to organize hives and expand searching of related content.

HTML answer  
A type of answer that appears to customers as standard HTML on the customer portal.

HTML editor  
An editor for formaing and editing answers, mailings, campaigns, documents, questionnaires, invitation messages,
and message templates in HTML without previous HTML experience.

identity provider  
A third party that authenticates user information and sends verication to a service provider, such as Oracle Service
Cloud, allowing single sign-on for the user. See also SAML 2.0 open login.

1801



Oracle Service Cloud
Using Service Cloud

Glossary

IMP (import) le  
A data le with an extension of .imp that is used by the Kimport utility to map values in the CSV le to columns in the
database.

In Meeting  
One of the default chat agent statuses. This status indicates that the agent is in a meeting and is unavailable to chat.
The In Meeting chat agent status has an Unavailable status type.

Inactive  
One of the default opportunity statuses and status types. An opportunity with the Inactive status is no longer being
pursued but could be activated at a later date.

inbox  
An agent’s personal queue consisting of all the incidents that have been assigned to the agent.

inbox limit  
The maximum number of incidents in an agent’s inbox that cannot be exceeded when pulling from a queue. The inbox
limit is set in the prole to which the agent is assigned.

incident  
Any question or request for help submied by a customer through the Ask a Question page, email, a chat session, site
or answer feedback, or from an external source using the API. Incidents can also be added by agents when they work
with customers by phone, fax, or mail, and when responding to a private Twier message.

incident archiving  
A process that permanently removes incidents from the database. Archived incidents are then stored in searchable data
les. Sta members can access archived incidents once the Archived Incidents component has been added to their
navigation set.
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incident custom eld  
A eld for gathering and displaying additional information about incidents. Incident custom elds appear when adding
or editing an incident and on the Ask a Question and Support History pages on the customer portal.

incident thread masking  
A method of protecting sensitive customer information, such as social security and credit card numbers, from
displaying in incident threads. Three default system masks are available and custom masks can be created.

incident queue  
A sequence of unassigned, unresolved incidents. When an incident queue is added, it can be dened as the default
queue. Incidents are added to queues automatically by business rules or manually by re-queuing and are handled in a
rst-in, rst-out manner.

incident severity  
An option for classifying and recording an incident’s importance and urgency.

incident status  
A method of tracking an incident’s state. The default incident statuses are Solved, Unresolved, Updated, and Waiting,
and custom statuses can be added.

incident status type  
The status of an incident as it moves through the system. Default incident status types are Solved, Unresolved, and
Waiting.

incident thread  
The list of all activity on an incident, including the original question, agent responses and updates, customer updates,
records of conversations, and internal notes about the incident (which are not visible to customers). The incident thread
lists activity in chronological order and can be ltered by thread type.
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index  
A database item that can be added to a database eld to speed up searches for information in the eld. Adding an index
to a eld increases the amount of time it takes to write information to the eld, and indexing a large number of elds
decreases the overall responsiveness of the database. Generally, only elds containing a large amount of information
that are regularly searched on should be indexed. In Oracle Service Cloud, indices can be added to most custom elds
and custom objects. See also custom eld and custom object.

indexing  
A process in which the text of an answer or incident is stemmed and indexed into keywords and phrases. These
keywords and phrases are used to build the answer and incident phrases tables that are used during text searching.
When an answer is added or updated, the Keywords, Summary, Question, and Answer elds are stemmed and indexed
to create one-, two-, and three-word phrases. When an incident is added or edited, the Subject eld and incident thread
are stemmed and indexed to create one-word phrases.

industry type  
An option for classifying organizations by type of industry.

information gaps  
A report that clusters incidents and compares the topics to answer clusters, allowing organizations to pinpoint those
areas (or gaps) in the knowledge base needing additional answers.

initial state  
A required state in every rule base. The rules engine evaluates a new or updated object using all rules in the initial state.
Unless one or more rules in the initial state transition the object to a function or dierent state, the rules engine stops
after all the rules in the initial state have been processed. See also rule state.

inline  
A method of displaying output denitions and lter denitions as lines of text in the report. See also output denition.
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inlay  
A portion of code controlling a number of functions that you can deploy on an external web page or on traditional
customer portal pages.

inline editing  
A feature for editing values directly on a report without having to open each record to make changes. Sta members
can edit individual values in one record or select several rows to change values in multiple records. Sta members must
have permission in their prole to edit the specic record type, and inline editing must be enabled in the report.

inner join  
A relational database operation that selects rows from two tables on the condition that the value in the specied column
of the primary table is equal to the value in the specied column of the secondary table. See also outer join.

interface  
The console, windows, and pages used by sta members and customers to access an Oracle Service Cloud application
and interact with a single knowledge base. The interface name determines the URL for the website, the name of the
executable, and the .cfg directory name. See also administration interface and agent desktop.

Interface Manager  
A utility for managing multiple interfaces using one knowledge base.

invitation method  
A way of distributing a broadcast survey, transactional survey, or website link survey.

Kexport  
A utility for exporting either single tables or an entire database from an Oracle Service Cloud application.
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Keywordindexer  
A utility that creates an index of the keywords found in incidents, answers, le aachments, and documents indexed by
the Web Indexer. The keyword indexes are used when searching incidents, answers, le aachments, and other indexed
documents. See also Web Indexer.

Kimport  
A utility for importing data, either single tables or an entire external database, into the database.

knowledge base  
All information (such as answers, assets, incidents, contacts, organizations, opportunities, products, sta accounts,
tasks, mailings, and campaigns) maintained and presented by Oracle Service Cloud in a meaningful way. Knowledge
base also refers to the interrelationships among the pieces of information.

knowledge engineer  
The sta member responsible for populating and maintaining the answers in the knowledge base. Responsibilities may
include identifying when answers should be added, editing proposed answers, and reviewing existing answers to keep
them current.

Langcvt  
A utility for changing the language pack in Oracle Service Cloud from English to an alternative language pack. This
utility converts the message bases and pre-populated knowledge base to the new language.

language  
The language for a specic interface that determines, in part, what answers are visible for viewing by customers.

Launched  
A mailing and survey status that indicates a transactional mailing or transactional survey has been launched and can be
included in a rule or campaign.
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layout  
A predened format that can be used in custom reports to apply fonts, colors, and other display options. Layouts can
also be used in dashboards to apply a predened structure for inserting reports.

lead  
A potential opportunity. A lead is a contact discovered through a marketing campaign and forwarded to a sales
representative through Opportunity Tracking. See opportunity and Opportunity Tracking.

lead rejection type  
An option for classifying and recording the reasons for rejecting a lead.

leaf level  
A level of product, category, or disposition that does not contain any sublevels. See product linking.

learned link  
Related answers that have a learned relationship as a result of customer activity.

Live Chat  
A link on the sidebar on the Customer Portal template that customers can click to submit a request to chat with a chat
agent.

Live Media bar  
The toolbar that displays when Chat is enabled. The Live Media bar allows agents to log in, log out, set their status, and
manage chats. See Oracle RightNow Chat Cloud Service.
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local seings  
Customizations made by sta members to dialog and tool window sizes and locations, as well as content pane and
navigation pane seings, console color and tint, toast notications, and report appearance, including display and
data seings and column formaing. Changes made by sta members to customize these seings aect only their
workstation. In addition, sta members can return to the system defaults at anytime.

logical expression  
An expression that denes the relationship between report lters or business rule conditions. The components of a
logical expression are joined using Boolean logic and can be grouped and joined with AND, OR, and NOT operators.

logical operators  
The symbols, (+) and (–), that can be used in most search techniques in Service to explicitly nd answers that have a
word (+) or that do not have a word (–).

Login window  
A dialog box for entering user name, password (if required), and site information to access the administration interface
of an Oracle Service Cloud application.

Lookup eld  
A eld in a custom object designated to store values that are used as the names of the object’s records. These names
display on editor tabs and the navigation pane’s Recent Items list. For instance, the Recent Items list displays incident
reference numbers since the Reference # eld is designated as the lookup eld for incidents. Values in lookup elds
are also displayed in reports instead of the ID values from elds in other tables that link to the lookup eld’s table. For
instance, while the incidents table’s Assigned Account eld stores account ID numbers, the values displayed for this eld
in reports are from the accounts table’s Full Name eld.

Lost  
One of the default opportunity statuses and status types. An opportunity with the Lost status has been lost, for
example, to a competitor.
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mailbox  
An email box specied in Oracle Service Cloud and dedicated to collecting email inquiries sent by customers, responses
to mailings, and bounced messages. Incoming emails are processed by the Techmail utility. See also Oracle-managed
Service mailbox and Techmail.

mailer daemon (rnmd)  
A utility that monitors Outreach and Feedback, listening for requests from other components to start the email process.
The mailer daemon is installed during the initial installation and can be congured to send messages in the most
ecient manner for an organization.

mailing  
A collection of one or more messages sent to one or more contacts. A mailing can contain multiple messages for testing
purposes.

mailing status  
A method of tracking the state of a mailing. The default mailing statuses include Draft, Launched, Scheduled, Preparing
to Send, Sending, Suspended, Suspended by Error, Canceled, and Completed.

manual policy  
A pull policy that enables agents to manually pull incidents into their inbox from any queue designated in their prole.

manually related answer  
A relationship between two or more answers manually dened by a sta member.

market testing  
A method for testing dierent message formats in mailings and surveys on a percentage of the audience before
launching a nal email. For broadcast mailings and surveys, market testing is available in even split and random
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sampling modes. For transactional mailings and surveys, market testing is available in audience sampling mode. See
audience sampling mode, even split mode, and random sampling mode.

mask  
A dened paern that determines the format of information that can be typed in a eld.

Master template  
The seings that dene a community’s navigation elements, footer content, and ne print text.

matrix question  
A question type for displaying a series of survey questions in a table. Matrix questions are useful when a group of
questions can be responded to with the same set of answer choices.

member  
A community user who has a login and can be associated with one or more groups in the community.

member type  
A classication for community group members that denes their role and provides access to certain group functions.

merge eld  
A variable eld that looks up account, contact, incident, opportunity, organization, or tracked link information and
inserts it in the text of a document, snippet, document template, message template, quote template, or the message
content and mail aributes of mailings and surveys.

merge report  
A report that can be included in marketing and survey content that dynamically limits the data returned so that
customers see only their own information. For instance, if the report lists contacts and their open incidents, customers
see only their own open incidents.
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message  
An email consisting of a collection of HTML, text, and images in a particular format.

message base  
An editable text string that allows international language support and customization of headings, labels, buons, and
other text on the administration interface and customer portal and in email messages and notications.

Message Bases editor  
The interface element used to customize the message bases, including all the headings, labels, buons, and other text,
on the administration interface and customer portal.

message templates  
A component for customizing and standardizing the content of administrator notications, administrator emails, and
contact emails. Message templates consist of a global template, which is used to standardize the design of outgoing
messages, and a set of system-generated messages. See also global template.

migration  
The process of moving from one version of the Customer Portal framework to a newer one. Migration can occur
independently of upgrading to a newer version of Oracle Service Cloud. See also upgrading.

mobile customer portal  
The template and set of customer portal pages that have been optimized for display on mobile devices such as iPhones,
Androids, and Palms. See also template and reference implementation.

model question  
The associated question and answer that reside in the Virtual Assistant database. Model questions are linked to answers
in the knowledge base and are displayed as similar questions on the Answers page of the customer portal. See Oracle
RightNow Virtual Assistant Cloud Service.
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Monitor  
A feature in Chat that allows a supervising agent to monitor the chat sessions of other agents and to intervene when
necessary.

Msgtool  
A utility for creating a conguration report for an Oracle Service Cloud site, or for changing conguration seings when
an error has been made in one of the seings that subsequently locks sta members out of the Conguration Seings
editor.

multi-select  
A feature for updating more than one record at a time.

multiline  
A method of displaying report data grouped under headings based on common values in report columns.

natural language  
Any approach that accepts and correctly handles human language. For example, English, French, and Japanese are
natural languages, while computer languages, such as FORTRAN and C, are not. The knowledge base can be searched
using natural language technology.

navigation buons  
The buons on the navigation pane associated with record types and components. Clicking a buon displays the record
type or the component’s navigation list.

navigation list  
All the reports, folders, and items associated with a specic record type or component in Oracle Service Cloud.
Navigation lists are organized in a tree on the navigation pane.
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navigation pane  
The area on the left and right side of the console where sta members work with navigation lists, select items to
open on the content pane, and search the knowledge base. In the default conguration, the left navigation pane
contains Recent Items and Navigation tool windows; the right navigation pane contains the Quick Search tool window.
What appears on the navigation pane depends on the navigation set assigned in each sta member’s prole and
the permissions assigned in the prole. Each navigation pane can also be customized by sta members. See also
Conguration buon, navigation buons, and Tool window.

navigation set  
Any combination of navigation buons and their associated navigation lists. The Conguration buon can also be
added to navigation sets. Sta members are assigned a default navigation set in their prole.

next-update checklist  
The UMS checklist that keeps track of all recurring tasks for each product enabled in your application. When the next
update is scheduled, the tasks in this list checklist are automatically added to the pre-update checklist.

normalized URL  
A URL that has been reformaed to ensure that documents that are referred to by multiple URLs will be indexed only
once. Normalization may include reformaing domain names (for example, removing capital leers) or removing query
parameters.

note  
Information that can be added to campaigns, contacts, documents, mailings, opportunities, organizations, and surveys
for internal reference. Notes can also be added to incidents in the incident thread.

notication  
A message that noties appropriate sta members about incidents, answers, mailings, campaigns, opportunities, and
system errors. See also Answer update notication.
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object  
Any standard or custom table in the Oracle database. Object also refers to the specic answer, contact, incident, chat
session, opportunity, organization, target, or task that is evaluated by the rules in the object’s rule base. See also custom
object, Oracle Service Cloud standard object, and rule base.

object event handler  
A PHP script with an integrated test harness (automated test script) that executes as the result of an event occurring on
a standard or custom object in Oracle Service Cloud. See also custom object, Oracle Service Cloud standard object, and
process model.

oer  
A promotion developed by marketing personnel or a product suggestion generated automatically by Oer Advisor that
is presented to a customer by an agent.

Oer Advisor  
Functionality for creating and presenting promotions to customers and for making automatic recommendations based
on customer aributes and purchase history.

On Break  
One of the default chat agent statuses. This status indicates that the agent is on break and is not available to chat. The
On Break chat agent status has an Unavailable status type.

open login  
The ability to log in to the customer portal using an already established external account, such as Facebook, Twier, or
Google. When the external site validates the customer and the customer approves the transfer of information to Oracle
Service Cloud, a contact record is created using the email address and the customer is automatically logged in to the
customer portal.
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operating system  
The program that, after being initially loaded onto the computer by a bootstrap program, manages all other programs in
a computer. UNIX, Windows, VMS, OS/2, and AIX are all examples of operating systems.

operational database  
The database that contains the live data that is viewed, retrieved, and edited in an Oracle Service Cloud application.
While reports that are run on the operational database can access real-time data, the reports cannot process as much
information as reports that are run on the report database. See also report database.

operator  
A symbol or word that represents a mathematical or logical action that can be applied to a condition or value.

opportunity  
Information about a specic sale or a pending deal that is tracked and maintained in the knowledge base.

opportunity custom eld  
A eld for gathering and displaying additional information about opportunities. Opportunity custom elds appear when
adding or editing an opportunity.

opportunity status  
A method of tracking an opportunity’s state. The default opportunity statuses are Lead, Reject, Active, Closed, Lost,
Inactive, and Dead. Custom statuses can also be added.

opt-in  
The explicit granting of permission by a contact to receive email communications from an organization. Opt-ins can be
specic to certain mailing lists or applied globally across all mailing lists.
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opt-out  
An explicit request by a contact to be removed from a specic mailing list or from all lists, most often communicated by
email or web form. Also called Unsubscribe.

Oracle-managed Service mailbox  
The recommended type of Service mailbox created by Oracle. Oracle congures the initial mailbox setup, including
enabling incoming email and dening the Pop Server, POP Account, and Password elds. Administrators can also create
general Service and Outreach mailboxes for their application.

post-update checklist  
A UMS checklist that contains tasks that are specic to and created by your organization. The tasks on this list are
enabled when your update is complete. See also pre-update checklist and next-update checklist.

Oracle RightNow Analytics Cloud Service (Analytics)  
A business reporting solution that enables organizations to capture, organize, present, and disseminate real-time
actionable knowledge with speed and ease. Using Analytics, organizations can increase insights by identifying
customers based on previous interactions across all channels.

Oracle RightNow Chat Cloud Service (Chat)  
A component that provides customers with access to chat agents for questions and issues that require human
interaction.

Oracle RightNow Connect Desktop Integration
(JavaScript API)  
A public API that enables customers and partners to integrate data contained on a workspace with a web page that is
contained on the workspace. If external information is presented about the current record in a web page, this API can be
used to update or read workspace data from the web page. See also workspace.

1816



Oracle Service Cloud
Using Service Cloud

Glossary

Oracle RightNow Connect PHP API Cloud Service
(Connect PHP API)  
A backward-compatible, public API that enables customers and partners to integrate with the Oracle Service Cloud
platform using PHP scripts. Connect PHP API is primarily used to integrate with the customer portal, but it can also be
accessed through the File Manager, process designer, and analytics. Connect PHP API leverages the Connect Common
Object Model, which is also leveraged by Connect Web Services for SOAP.

Oracle RightNow Connect Web Services for SOAP
(Connect Web Services)  
A backward compatible, public API that enables customers and partners to integrate with the Oracle Service Cloud
platform using industry leading standards such as WSDL 1.1 and SOAP 1.1. It provides broad support for a wide variety
of languages, platforms, and tools. Connect Web Services leverages the Connect Common Object Model, which is also
leveraged by Connect PHP API. See also Oracle RightNow Connect PHP API Cloud Service.

Oracle RightNow Customer Portal Cloud Service
(Customer Portal)  
The website interface that customers access for customer support. The customer portal is integrated with Service
so customers can query the knowledge base for answers, ask questions, provide feedback, manage their customer
account, and request chat sessions. It consists of a standard set of les that can be customized, uploaded, staged, and
promoted to make the site available to customers. See also Mobile customer portal.

Oracle RightNow Cloud Service (Service)  
A customer service and support solution that intelligently assists both customers and agents with inquiry resolution
across standard and social channels. Service assists customer service and support organizations that need to easily
capture, respond to, manage, and track all service interactions in one consolidated application.

Oracle RightNow Desktop Add-Ins Cloud Service
(desktop add-ins)  
An add-in framework for the Oracle Service Cloud platform that enables customers and partners to build custom .NET
components, controls, and applications for the agent desktop. See also Agent desktop.
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Oracle RightNow Feedback Cloud Service (Feedback)  
A customer survey tool for gathering information about customers’ experiences with an organization. With a wide range
of customization and formaing options, questions types, and full analytics for ecient reporting, surveys provide
organizations with a exible method of tracking customer satisfaction.

Oracle RightNow Opportunity Tracking Cloud Service
(Opportunity Tracking)  
A sales automation solution that enables sta members to easily manage all opportunity, organization, and contact
information and track all quote interactions in one consolidated application.

Oracle RightNow Outreach Cloud Service (Outreach)  
An email and campaign solution for delivering personalized, richly formaed email communications to targeted
segments of customers and prospects and for launching full-scale marketing campaigns.

Oracle RightNow Self Service for Facebook Cloud Service
(Self Service for Facebook)  
A Facebook application that provides access to customer-facing features of Oracle Service Cloud, such as Find Answers
and Ask a Question, directly from Facebook’s web and mobile interfaces.

Oracle RightNow Social Experience (Social Experience)  
A set of complementary components, including Communities, Channels, Social Monitor, and Self Service for Facebook,
each representing a dierent, powerful way of interacting with customers using social media. While each component
serves a distinct purpose, they can be used together to create a wide-ranging social web presence.

Oracle RightNow Social Experience communities  
A comprehensive social web solution consisting of Oracle RightNow Support Community Cloud Service and Oracle
RightNow Innovation Community Cloud Service that lets customers connect, discuss, and contribute through forum
discussions, question-and-answer sessions, resource libraries, and suggestions for service improvements.
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Oracle RightNow Social Monitor Cloud Service (Social
Monitor)  
A monitoring tool for gathering and acting on information about an organization and its products that appears on social
networking services such as Twier and YouTube.

Oracle RightNow Virtual Assistant Cloud Service (Virtual
Assistant)  
A solution for identifying the intention behind a customer’s question using semantic search technology and linguistic
dictionaries to return highly relevant search results and provide virtual assistant chats.

Oracle RightNow Wireless  
The interface for accessing Service from a wireless phone or any device with a WAP (wireless application protocol)
browser, such as a PDA (personal digital assistant).

Oracle Service Cloud  
A customer experience suite combining web, social, and contact center experiences for a unied, cross-channel service
solution in the cloud.

Oracle Service Cloud Smart Client  
The web-based software that allows local applications to interact with the server-based applications. The smart client
can be installed on sta workstations using the Click-Once installer. See also Click-Once installer.

Oracle Service Cloud standard object  
Any standard table that is native to Oracle Service Cloud. Standard objects store data, including record types such as
answer, contact, incident, opportunity, organization, and task. Other standard objects include accounts (sta accounts),
assets, quotes, and sales products. See also custom object and object.

1819



Oracle Service Cloud
Using Service Cloud

Glossary

organization  
Any company, business unit of a large company, or government agency that has an organization record in the
knowledge base.

organization address type  
A way of storing multiple addresses for a single organization. The default organization address types are Billing and
Shipping; custom address types can be added.

organization association  
A feature for associating a contact with a specic organization. Organization association links the incident and
opportunity history of the contact and organization.

organization custom eld  
A eld for gathering and displaying additional information about organizations. Organization custom elds appear
when adding or editing an organization.

organization hierarchy  
A feature for creating or changing the hierarchy of organizations. A hierarchy can be created by making one or more
organizations subordinate to another organization. Twelve hierarchy levels can be used.

outer join  
A relational database operation that selects rows from two tables regardless of whether the specied columns contain
corresponding values. An outer join will return all rows from the primary table and any rows from the secondary
table where the value in the specied column of the primary table is equal to the value in the specied column of the
secondary table. See also inner join.

output denition  
A description of a report that can be viewed when generating a report or when hovering over the report title and
columns. Output denitions are predened for all standard reports and can be dened when creating a custom report.
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output level  
A distinct section of a report that outputs report data. Reports can have multiple output levels, each of which can have
their own lters, groupings, data exceptions, headers, footers, and descriptions. Output levels in a report are related
through drill-down links and drill-down lters.

owner  
The member who holds complete authority over a community group or hive. A member who creates a group or hive is
designated as its owner unless ownership is transferred.

page  
A web page or a customer portal page in an Oracle Service Cloud application.

page set mapping  
The customer portal functionality that allows a specic page set to be mapped to a specic user agent. Customers are
then directed to the most appropriate page set as determined by the browser or user agent accessing the customer
portal.

panel  
A customizable object used to display dynamic content on community pages. Panels can be added to custom pages and
some standard pages. See also custom page.

path  
The connector between items in a campaign ow diagram. A path can be one of four types (Standard, Submit, Yes, or
No) and can connect two actions or an action and a decision in campaigns. See also action and decision.

Personal seings  
An application option that lets sta members override seings in their sta account and customize seings that apply
to the interface defaults in Oracle Service Cloud. Seings dened in sta accounts that can be changed include default
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currency, default country, time zone, and email notications. The sta account seings changed from the Personal
Seings option will also be made to the corresponding seings in the sta account.

pipeline  
Calculated revenue that has not yet been acquired but is forecasted to close in a specied time period.

polling survey  
A survey that displays as a single question on a customer portal page or any page external to the customer portal.
After customers submit their response, they see a poll results chart or a thank you message. See also Oracle RightNow
Customer Portal Cloud Service.

post  
Content added by users of a social media site, such as a Facebook status update or a text entry in Social Experience
communities. See Oracle RightNow Social Experience communities.

post type  
The structure of a post as dened by the sequence of elds and controls used to create its content.

pre-update checklist  
The UMS checklist that becomes active when you request an update. It includes a list of Oracle-created tasks and any
custom tasks that should be completed before your update.

preliminary screen pop  
The toast notication that displays when an incoming chat request is received. The preliminary screen pop displays as a
two-column table, and agents can view information about the chat request before accepting or declining the request.

Preparing to Send  
A mailing and survey status that indicates a broadcast mailing or broadcast survey is about to be sent.

1822



Oracle Service Cloud
Using Service Cloud

Glossary

price schedule  
An option for creating various pricing levels that can be assigned to sales products. Price schedules allow the same
product to have dierent prices, such as wholesale and retail prices.

primary contact  
The main individual associated with an incident or opportunity. All primary contacts have an associated contact record
in the knowledge base. In Service, a primary contact must be associated with an incident for agent responses. In
Opportunity Tracking, either a primary contact or an organization must be associated with an opportunity to serve as a
point of contact for sales representatives during the sales process. See also contact.

primary key  
A database table column that is indexed to enforce a unique constraint, meaning that a given value cannot appear more
than once in the column. This column is used to uniquely identify each record in the table. Primary keys are often the
target of a foreign key in a dierent table. See also foreign key.

priority  
A ranking that denes the order in which incidents are pulled from multiple queues. The priority ranking also identies
which queues agents can retrieve incidents from.

private  
One of two default answer status types. Answers that are marked Private are never visible to customers. See Answer
status type.

private key  
A password-protected key used by the holder to create digital email signatures and decrypt messages that were
encrypted using the holder’s associated public key.
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privileged access answers  
Answers that are assigned a custom access level for viewing by certain contacts and organizations assigned to the
appropriate service level agreement (SLA). See SLA.

process model  
The virtual container that encompasses all event handlers (standard and custom) in Oracle Service Cloud. Using the
process designer, a process model can be exported, imported, deployed, and rolled back. See also custom object, object
event handler, and Oracle Service Cloud standard object.

product  
An option for grouping answers and incidents that allows more precise organization in the knowledge base. Sta
members can classify answers and incidents by product and up to ve additional levels of sub-products, allowing more
rened searching by customers and sta members. See also category.

product catalog  
The list for organizing sales and asset products. See Asset product and Sales product.

product linking  
An option for linking products to categories and products to dispositions so that category and disposition choices are
narrowed to only those associated with the selected product for sta members working with incidents and customers
searching on the customer portal.

Production area  
The set of publicly available customer portal les and pages. The production area is updated when les in the
development folder are staged and promoted. See also Development area.

prole  
A mechanism for controlling access to administration functions and for assigning sta members specic permissions,
default workspaces, a default navigation set, and report access.
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promote  
To copy all customer portal pages from the staging area into the production folder, where they become publicly
available on an organization’s website.

promotion  
A specic message (for example, a discount, renewal notice, or announcement) delivered to a specic group of
customers using Oer Advisor. Promotions are generally created by marketing sta members and presented to
customers by agents. See Oer Advisor.

proof  
A way to review the content of a mailing or survey to ensure the message is approved by the necessary contacts and
sta members and as a nal check for any mistakes. Proofs can be sent to a proof list or group of sta members who, in
turn, can accept or reject the proof. Proof messages can also be sent to sta members when changes have been made
to message templates. See also message templates.

proof list  
A contact list that is available to receive proof messages, enabling its contacts to review mailings and surveys before
they are nalized.

propose answer  
A function for proposing that an incident’s solution be added to the answers available to customers. The proposed
answer is reviewed by the knowledge engineer, who determines if it should be made public and, if so, its access level,
status, language, and visibility.

Proposed  
One of the default answer statuses. This answer status indicates that the answer has been proposed by a sta member
from an incident. Answers with a Proposed status are not visible to customers. See Answer status.
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Public  
One of the default answer statuses and status types. Answers marked Public may be visible to customers depending on
their access level and language. See Answer status and Answer status type.

public certicate  
See Certicate.

public key  
Public information that may be aached to email messages to allow those who reply to the message to encrypt their
response. The public key also veries that the digital signature was created with the associated private key, thereby
ensuring the integrity and authenticity of the message. Public keys are often referred to as public certicates, although
certicates hold additional information besides the public key.

public key certicate  
See Certicate.

publish report  
A method of preserving a report's graphical and tabular output as a snapshot. After a report is published, it cannot be
modied and the report data will remain unchanged even as the knowledge base is updated.

pull policy  
The method for determining which queues agents can retrieve incidents or receive chat requests from and in what
order. Pull policies include Strict Priority, Manual, and First Due.

pull quantity  
The specied number of incidents to be retrieved from the queue at one time when an agent pulls incidents.
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question  
The main element in a survey. Text, choice, and matrix question types can be created. Questions can be used in multiple
surveys, mixing and matching as necessary. See Choice question, Matrix question, and Text question.

questionnaire  
The complete set of questions and all the pages in a survey. Using the HTML editor, sta members can create dynamic
surveys using a graphical interface to add questions and create survey branches based on how customers answer. A
questionnaire must be created for each survey.

queue  
See Chat session queue and Incident queue.

queued report  
A report that has been manually or automatically scheduled to run in the background after entering the report’s search
criteria. When a queued report has been generated, a toast notication displays with a link to open the report.

Quick Access toolbar (QAT)  
One or more buons used as shortcuts to commands on the ribbon. The initial set of buons on the Quick Access
toolbar is specied by what is displayed on the content pane, but sta members can customize the toolbar to add
frequently used buons. By default, the Quick Access toolbar appears above the ribbon.

Quick Search  
A component used to search for records and les when only limited information is known. Quick Search can be used
to search the knowledge base no maer what navigation list is displayed or what is open on the content pane. Oracle
Service Cloud contains a number of default Quick Search reports, and other reports can be added to the Quick Search
buon in navigation sets.

quota  
The revenue goal assigned to a sales representative during a specied time period, such as month or quarter.
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quote  
A formal price assigned to a sales product for a particular customer during a sales period. Quotes also include any
discounts applied as well as the valid dates for the quote.

quote custom eld  
A eld for gathering and displaying additional information about quotes. Quotes custom elds appear when sending a
quote with an opportunity.

quote template  
A template dened for a specic type of quote. Quote templates are used when generating a quote for an opportunity.
See also quote.

random sampling mode  
A market testing option for broadcast mailings and surveys that sends test messages to a specied percentage of the
audience. See market testing.

record  
Any individual answer, asset, contact, incident, opportunity, organization, or task in the knowledge base. Records can
also be created for custom objects, which can be added to Oracle Service Cloud to integrate organization-specic data
with the Oracle database. See also Custom object, Oracle Service Cloud standard object, and Record type.

record type  
A database table that stores all records of the same type, such as answers and incidents. See Record.

record pool  
The memory space used to temporarily store all records loaded in a single desktop workow session. See Desktop
workow.
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record tabs  
The layout of information contained in a record. Each tab contains specic elds and options related to the record that
can be viewed and updated as necessary.

recurrence  
A scheduling method used to send or initiate the same report, mailing, survey invitation, campaign, or cloud search on a
regular daily, weekly, monthly, or annual basis.

reference implementation  
The standard set of les used to create the default customer portal as it exists without customization.

regular expression  
A combination of operators and character strings used to dene a search eld or a condition statement in a business
rule.

Reject  
One of the default opportunity statuses and status types. A lead with the Reject status has been rejected by a sta
member.

related answers  
A feature that assists customers in nding answers to questions related to the current web visit. Related answers appear
on the answer details page and are sorted by relatedness those answers that appear at the top of the list are most
related to the answer being viewed.

relationship item  
A control used to create workspaces. Relationship items can include lists of records as well as other information such as
audit logs and le aachments.
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relative time  
The amount of time between events based on the business work hours dened in service level agreements or default
response requirements. Some functions, such as rel_date_diff(), support relative time values, as do some database
elds such as inc_performance.rel_time. Note that the Relative option available for use in some lters has a dierent
meaning where a dynamic time period can be dened instead of a time period using a static date and time. See also
absolute time.

relative value  
A eld value set by a workow, script rule, or workspace rule that adds or subtracts, appends, or prepends, a value to the
eld’s previous value (for instance, increasing the value of an integer eld by 1).

report  
Any standard report, custom report, or list of records accessed from a navigation list on the navigation pane. Standard
and custom reports can also be accessed from the Reports explorer. Reports are also used to display lists of answers or
a customer’s incidents on the customer portal.

report database  
A copy of the operational database that is used for reporting purposes. Reports that are run on the report database
can process more information than reports run on the operational database. The data in the report database is copied
from the operational database at scheduled intervals and therefore may not be as current as the data in the operational
database. Also called replication database. See also operational database.

report control  
A control that inserts a report into a workspace. See also workspace.

report linking  
A feature for creating links between reports. Linked reports and dashboards can be seamlessly opened from other
reports, just as report levels can be opened from other levels in the same report. Both conditional and unconditional
links can be created.
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report schedule  
An option for subscribing to a standard or custom report. Sta members can schedule the report to be sent to an
individual sta member, a group of sta members, a distribution list, an external email address, or any combination of
these options.

report section  
A section of an output level that contains a component of the report’s output, such as a title, chart, or tabular data.

report variable  
An item added to a report that is used to return dierent data or data in dierent formats in the same column. For
example, a single report can be created that displays the number of incidents by sta member, group, queue, or status.
When running a report, the variable value is selected from the Search window or from docked lters.

Reportgen  
A scheduled utility that sends out scheduled reports. See Report schedule and Scheduled report.

re-queuing  
The action of moving an incident from an agent’s inbox into a queue.

resolution time  
The maximum allowable time (in minutes) set by a service organization for resolving incidents. See also response
requirements.

response interval  
The days of the week and times when a service organization makes itself available to respond to and solve incidents on
a daily basis. Days and hours can be specied. See also response requirements.
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response requirements  
The maximum time allowed (in minutes) for incident response and resolution within the operating hours dened by
the organization. The response requirements are used to measure agent performance in responding to and solving
incidents and can also be used for SLAs that do not have customized response requirements. See also SLA and
response interval.

response time  
The maximum allowable time (in minutes) set by a service organization for initially responding to new incidents. See
also response requirements.

result grouping  
A feature in a report denition for selecting elds to group data by. Result grouping provides a more organized view of a
report. Multiple levels can be dened for result grouping. The more levels used, the ner the detail will be.

Review  
One of the default answer statuses. This status can be used to notify the knowledge engineer when a public answer
needs to be reviewed. See also answer status.

ribbon  
All the tabs and buons for performing actions and functions on an entire report, individual records in a report, or items
in an explorer tree or list. The buons on each tab are grouped by related functions, and each group is labeled. The tabs
and buons on the ribbon change based on what is displayed on the content pane.

rollover  
A method of displaying additional report details by hovering over data described in the report’s output denition.

rollup  
A method of displaying report data that groups records together by specic elds. The grouped records are displayed
under headings that can be expanded or collapsed to display or hide the records under the heading.
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root certicate  
A self-signed certicate generated by a party that signs other public certicates. Certication authorities may authorize
other entities to issue certicates. The root certicate belongs to the top-level certication authority.

round-robin queue  
A type of incident queue in which unresolved incidents are automatically assigned to agents in a rotating fashion.

RPA (responses per assignment)  
A statistic that calculates the average number of times a sta member or group responded to each incident.

RSS (Really Simple Syndication)  
The primary standard used for the syndication of web content. RSS is an XML-based format used primarily for
distributing news headlines on the Internet. Oracle Service Cloud contains an RSS channel so sta members can
monitor RSS feeds for content. See Oracle RightNow Social Monitor Cloud Service.

rule  
See Business rule.

rule base  
All rules, states, functions, and variables associated with a particular object type (answers, contacts, incidents, chat
sessions, opportunities, organizations, targets, and tasks) in business rules.

rule log  
A feature for viewing the rule or rules that have red against a specic answer, contact, incident, opportunity,
organization, or task. See also business rules.
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rule state  
A container for business rules. Every rule base must contain an initial state, and states can be added to handle all stages
of object processing. Rules in the initial state can transition objects to other states in the rule base. See also initial state.

rules engine  
The software that evaluates objects to determine if they meet the conditions of any rules in the rule base and then
executes the actions dened in the rules.

runtime selectable lter  
A component that denes the initial data set available in a report and allows sta members and customers to customize
the data returned. Runtime selectable lters are statements constructed from expressions, functions, and operators,
and can be customized when running a report.

S/MIME (Secure Multipurpose Internet Mail Extensions)  
A standard for sending secure email messages that can verify the sender’s identity. S/MIME emails can be encrypted for
security and signed to verify authenticity.

safe mode  
A login method that allows sta members to log in to Oracle Service Cloud without activating add-ins. Safe mode is
available after malfunctioning add-ins have prevented administrators and sta members from logging in. See Add-in.

sales period  
The period of time used to track the revenue goals assigned to each sales representative. The default sales periods are
annual, semi-annual, quarterly, monthly, and weekly.

sales product  
An option for identifying items or services sold by an organization. Sales products can be added to quotes and
promotions.
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sales products custom eld  
A eld for gathering and displaying additional information about sales products. Sales products custom elds appear on
the Custom Fields page of the Product Details editor.

sales representative  
A sta member who may be assigned opportunities and who may also maintain contact and organization records.

SAML (Security Assertion Markup Language)  
An XML-based protocol in which an identity provider authenticates a user’s identity and passes that information to a
service provider, which can then decide to allow the user access to the service without requiring an additional login
procedure. See also identity provider, SAML 2.0 open login, and single sign-on.

SAML 2.0 open login  
A type of single sign-on that uses Security Assertion Markup Language (SAML) and is the protocol that Oracle Service
Cloud uses for its single sign-on feature. See also SAML and single sign-on.

Scheduled  
A mailing and survey status that indicates a broadcast mailing or broadcast survey is ready to be sent and will be
emailed at the scheduled send date and time.

scheduled report  
A report that is sent as an HTML email or HTML email aachment to sta members, distribution lists, or external email
addresses at specied times. Scheduled reports can also be sent when alerts dened in data exceptions are triggered.
See also exception.

schema  
The structure of a database system described in a formal language supported by the database management system. In
a relational database, the schema denes the tables, the elds in each table, and the relationships between elds and
tables.
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score  
A calculated value that ranks the order of displayed answers. An answer’s score is determined by its solved count
and any display position that was set when the answer was added or updated. Score also refers to the relative weight
assigned to each choice in a choice question for surveys. Score values can be used for survey calculations to trigger
rules or campaign actions based on a contact’s answers and also for reporting purposes.

screen pop  
See Third-party screen pop.

script  
A control that can be added to a custom workspace to help sta members enter record information in a logical order.
Scripts can contain multiple pages with elds and other controls as well as branching logic to guide sta members to
dierent pages based on actions they take on a script page.

script rules  
A type of rule used to trigger actions, such as seing the value of a eld, on script pages when specied conditions are
met.

search and selection criteria  
The runtime selectable lters and sorting options that can be dened when searching for a particular record. See also
runtime selectable lter.

search index  
A matrix that includes a list of important words within a document and their document of origin, allowing ecient
searching. In some cases, the matrix is a database table. In other instances, the matrix is a le stored on a hard drive.
For a word or phrase to be searchable within an incident, answer, le aachment, or external document, it must rst be
indexed.
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search priority word  
A word that is associated with an answer or a document. The associated answer or document will always be displayed to
customers when the search priority word is included in their search text.

secure email  
Incoming and outgoing email that has authenticity (the sender is who it appears to be), integrity (content has not
changed during transmission), and privacy (only the intended recipient can read it).

seeding  
The initial set of answers in the knowledge base.

segment  
The criteria for creating dynamic lists of contacts based on user-dened lters. Multiple lters can be created and logical
expressions can be used to create the exact data set needed to target contacts. After a segment is created, it can be
used in broadcast mailings and surveys and the group of contacts will be constantly adjusted and updated as they meet
or fall outside of the segment’s requirements.

self-learning knowledge base  
The automatic generation of self-service content based on customer interactions so that the most pertinent
information is presented. See also knowledge base.

sender ID  
A form of email authentication that identies IP addresses authorized to send mail on behalf of a specic organization.
Sender ID diers from SPF authentication primarily by the components of the email used to authenticate the message.

Sender Policy Framework (SPF)  
A form of email authentication that identies IP addresses authorized to send mail on behalf of a specic organization.
SPF diers from Sender ID authentication primarily by the components of the email used to authenticate the message.
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Sending  
A mailing and survey status that indicates the broadcast mailing or broadcast survey is currently being sent to contacts.
The system automatically sets the status to Sending after the mailing or survey is done being prepared to send or at the
scheduled date and time.

Service Console  
The user interface where sta members work in Oracle Service Cloud. Sta can add and edit records and items,
generate standard reports and create custom reports, access their notications, and chat with customers from this
console. Administrators can also congure and customize their application from the console. Also called administration
interface or agent desktop.

service level agreement  
See SLA.

sharing  
The process of sharing contacts, tasks, or both between Microsoft Outlook and Oracle Service Cloud. All sharing
functions are initiated from Outlook.

sibling answer  
Related answers that share the same product or category. Sibling answers may also contain the same le aachments.

single sign-on  
A method for a user (in Oracle Service Cloud, a sta member or customer) to log in to one application, known as an
identity provider, and then be authenticated and logged in to another application, such as Oracle Service Cloud, without
being required to log in separately to the second application. See also identity provider and SAML 2.0 open login.

sitemap  
A page on a web server using the XML-based Sitemap protocol. The page typically lists all the URLs for a site along with
metadata for each URL, including the priority of each page and when it was last updated.
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SLA (service level agreement)  
A contract that is applied to contacts and organizations specifying the level and type of customer service they are
eligible to receive. Generic SLAs are created by administrators, and SLA instances are applied to specic customers,
either automatically through business rules or manually by sta members. SLA instances are called service contracts on
the customer portal and can be accessed from the Account Overview page. See also response requirements.

SLA instance  
A customer’s individual copy of an SLA. An SLA is a generic contract that has not been applied to a specic customer.
An SLA instance is a copy of the generic SLA applied to a specic customer.

slicing  
A method of grouping tabular report data by a common element. When slicing, a common value in a eld can be
chosen and only those rows that have that value will be returned in the report. Other slice groups can be selected from
links or a tree element.

Smart Interaction Hub (SIH)  
Functionality for directing customer interactions to the most qualied source for resolution by leveraging agent skills.

Smart merge  
A feature that allows sta members to merge similar answers in the knowledge base to provide more meaningful
answers to customers and to reduce answer duplication.

SmartAssistant  
Oracle technology that uses business rules to automatically suggest possible answers to customers’ email questions
and Ask a Question queries. Sta members can use SmartAssistant to search for answers in the knowledge base that
are related to an open incident or a current chat session. See also suggested answers.
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SmartSense  
Oracle technology that estimates a customer’s emotional state or aitude based on the words and language the
customer uses when submiing a question in Service. SmartSense also rates the incident responses sent by agents.
The SmartSense ratings for both customer and agent appear wherever they have been placed on the workspace. In
Feedback, SmartSense evaluates text questions submied by customers in surveys. In social monitoring, SmartSense
evaluates posts returned from cloud searches.

snippet  
Any text or part of a document that can be used in more than one document. Snippets can be added to documents from
the Content Library component.

Social Monitor  
A component for searching social networking sites to monitor and act on conversations about an organization and its
products. See also Oracle RightNow Social Monitor Cloud Service.

Solved  
One of the default incident status types and incident statuses. An incident marked Solved has been resolved.

solved count  
The method for determining where an answer will display in the list of answers. The most useful answers (those with
the highest solved count) are pushed to the top of the list, while those with the lowest ratings are moved down on the
list. When a customer clicks one of the options in “Is this answer helpful?” on the answer details page, it directly aects
the solved count. The solved count is increased for answers that are viewed, and the last answer viewed has a higher
solved count than answers viewed earlier in the same web visit. The solved count is also increased when an agent uses
a SmartAssistant suggested answer when responding to a customer’s question. By default, customer inuence on an
answer’s ranking accounts for 75 percent of an answer’s score, and agents aect 25 percent. Over time, an answer’s
solved count gradually declines as it is viewed less frequently.

sort order  
The sort order of a report’s output columns. The default sort order is dened when generating a report and can be
modied when running the report.
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Spacer  
A control that is manually added to a workspace to maintain the row and column arrangement when elds and controls
are moved and removed or to create white space in a workspace.

spider  
See Web spider.

SSL (secure sockets layer)  
An industry standard for secure Internet-based transfer of information.

sta account  
The seings for a sta member authorized to access an Oracle Service Cloud application, including user name,
password, prole, group assignment, and email information.

sta account custom eld  
A eld for gathering and displaying additional information about sta members. Sta account custom elds appear on
the Custom Fields page of the Sta Accounts editor.

sta member  
Any employee with a sta account and prole authorized to access an Oracle Service Cloud application.

stage  
To compile and optimize all the customer portal pages from the development folder, where they are created and tested,
into the staging folder, where they appear exactly as they will when the staged les are promoted into production. Stage
also refers to the level of completion of a particular opportunity within a specic strategy. Tasks can be dened within
a stage and can be required to be completed before the opportunity can move to the next stage. See also promote,
strategy, and task.
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standard reports  
The complete set of predened reports available in Oracle Service Cloud. Standard reports can be copied and used to
create custom reports.

standard text  
Any text prepared in advance that can be sent to customers when responding to incidents, appended to responses by a
business rule, or sent by an agent during a chat session. Also called standard response.

State  
A eld that classies how contacts and organizations were added and what actions have occurred since their creation.
The State eld is automatically populated when a contact or organization record is added or updated, and sta
members can also manually update the State eld. State eld options include Service, Outreach, Opportunities, and any
combination of the three. State also refers to the current stage of an object in rules processing. See Rule state.

status  
The current state of an answer, incident, mailing, opportunity, survey, or task. See Answer status, Incident status,
Mailing status, Opportunity status, Survey status, and Task status.

status type  
The current state of an answer, incident, or opportunity. Default answer status types are Public and Private. Default
incident status types are Unresolved, Solved, and Waiting. Default opportunity status types are Active, Closed, Dead,
Inactive, Lead, Lost, and Reject.

stopword  
A word that is not included in the keyword indexes in Service and is not searchable as a result. Pronouns, articles, and
adverbs are common stopwords.
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strategy  
A sales plan dened by an organization that includes stages and associated tasks that must be completed in order for
opportunities to move through each stage. Strategies allow organizations to dene multiple sales plans based on their
business processes and help ensure that policies and procedures are enforced.

strict priority  
A pull policy that denes the order in which the system pulls incidents or chats from multiple queues. The strict priority
ranking also identies from which queues agents can retrieve incidents.

style  
All of the specications that can be dened for presenting graphical and tabular data in a report, including fonts, colors,
and borders.

subscription  
A type of cloud search that pulls all available thread content from a custom Facebook or RSS channel account at regular
intervals. See also cloud search.

suggested answers  
The list of answers from the knowledge base that is returned when SmartAssistant is invoked, either by sta members
working on incidents or engaged in chat sessions or through business rules that append answers to email questions
and Ask a Question queries from customers. See also SmartAssistant.

suggestion  
A product recommendation automatically generated by Oer Advisor using a predictive model based on customer
purchase history.

Support Home  
The entry page on the customer portal. This page provides customers with quick access to the tools they need to
answer their questions and receive immediate customer service.
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survey  
A method of gathering customer responses and feedback. Surveys can be sent as mailings, served as a web page, or
sent as events triggered by a campaign or business rule. See Oracle RightNow Feedback Cloud Service.

survey status  
A method of tracking the state of a survey. The default survey delivery statuses include Draft, Scheduled, Launched,
Recurrence Scheduled, Preparing to Send, Sending, Suspended, Expired, Suspended by Error, Canceled, and Completed.

Suspended  
A mailing and survey status that indicates a mailing or survey has been temporarily suspended from the Sending or
Launched status.

Suspended by Error  
A mailing and survey status that indicates a transactional mailing or transactional survey encountered an error and has
been temporarily suspended.

synchronization  
The process of collecting and combining contact and task records in Oracle Service Cloud and Microsoft Outlook to
ensure data is consistent between applications. Also called sync.

syndicated widget  
A Customer Portal widget that can access the Oracle Service Cloud database from any external web page. The code
used to place the syndicated widget on a web page is available under tag documentation on the Customer Portal
Administration site.

system aribute  
A customized eld that can be added to account (sta account), answer, asset, contact, incident, opportunity,
organization, quote, sales product, and task standard objects. System aributes can be displayed in reports and
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workspaces, and can be used when dening relationships between standard and custom objects. See Custom object
and Oracle Service Cloud standard object.

table instance  
A component of a data set that species the database tables that data can be selected from and how database tables
are joined in a report or segment.

target  
A specic group of customers sharing common characteristics to whom a promotion is presented. A customer may
belong to more than one target.

target rule  
A type of business rule that has the sole purpose of creating a target consisting of contacts who meet the conditions
established by the rule.

task  
An action or activity scheduled to be completed within a specied time. Tasks can be standalone, or they can be
associated with answers, campaigns, contacts, documents, incidents, mailings, opportunities, organizations, surveys,
and stages in a sales strategy.

task custom eld  
A eld for gathering and displaying additional information about tasks. Task custom elds appear when adding or
editing a task.

task inheritance  
A feature for linking a task’s assigned sta member, contact, or organization to the equivalent value in a record
associated with the task.
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task status  
A method of tracking a task’s state. The default task statuses are Not Started, In Progress, Completed, Waiting, and
Deferred.

Techmail  
A scheduled utility that retrieves mail from specied POP3 mailboxes. Service processes some of the mail into new
incidents and routes the incidents using business rules (depending on seings). Outreach and Feedback process
bounced messages to assist in tracking incorrect email addresses.

template  
A structured format used in a document in which specied sections are locked and cannot be edited and a section is
open for customized content. The customer portal also uses templates to apply a uniform style to individual pages of
the support site. Templates are also available as a starting point for creating a workow’s ow diagram, and templates
can be added for community groups and hives.

territory  
A specic geographical sales region congured in Opportunity Tracking. Sales representatives can be assigned specic
territories for opportunity assignment. Up to twelve levels of territories can be dened.

test message  
A mailing message that can be sent to small cross-sections of an audience to test a response before launching a nal
message.

text explanation  
A text eld that can be associated with a response in a guided assistance guide. The text explanation is displayed after
an agent selects the associated response from a question in the guide. See Guided assistance.
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text eld  
A customizable eld containing text that is commonly added to reports. After a text eld is created, it can be added to
any custom report and then adjusted as necessary.

text matching  
A feature in Oer Advisor that enables agents to search for specic terms that best express the customer’s interests.
After a search, the list of promotions and suggestions on the Oer Advisor window will be reordered, and the ranking of
each will reect its relevance to the terms entered by the agent. See Oer Advisor.

text question  
A question type that allows customers to type their answer to a question.

theme  
A group of related text responses to a survey question. Themes are created by topic monitoring and identied by
common keywords. Themes are also used in social monitoring to group related cloud search results and in the customer
portal to apply CSS styling to multiple elements of a support site by applying a single theme. See Oracle RightNow
Customer Portal Cloud Service, Oracle RightNow Social Monitor Cloud Service, and Topic monitoring.

third-party screen pop  
A feature that lets sta members open a Service Console or report from a third-party application. See Service Console.

Time Billed  
A way to track the time spent responding to incidents. Data from the Time Billed eld can be used for customer billing
and for determining average incident resolution time.

Tool window  
A default interface control on the Service Console for accessing reports, records, and items, and for searching the
knowledge base. Recent Items and Navigation tool windows appear on the left navigation pane, and the Quick Search
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tool window appears on the right navigation pane. Tool windows can be put in any order, displayed in separate, oating
windows, or removed from the console.

toolbar  
One or more icons used as commands on a workspace. The initial set of icons on the workspace’s toolbar is specied in
the record type’s workspace conguration, but administrators can customize the toolbar to add frequently used icons.

topic browsing  
A feature that provides clustering and guided browse functionality on the customer portal so customers can browse
specic topics to nd related answers.

topic monitoring  
A process that groups survey text responses into clusters of related responses called themes and labels each theme
with keywords that dene the responses. Topic monitoring is also used in social monitoring to group related cloud
search results. See also data mining and themes.

tracked link  
A link that can be tracked by Outreach and reported on for statistical purposes.

tracked link category  
An option for classifying tracked links for reporting purposes. A tracked link category can have one subcategory level.

transactional mailing  
A mailing that is sent only when an event occurs. Transactional mailings are sent to a contact when the contact meets
specied criteria in a campaign and can be scheduled to be sent immediately, on a specic date, or at an interval in the
future.
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transactional survey  
A survey that is sent only when an event occurs. Transactional surveys are sent to a contact when the contact meets
specied criteria in a campaign or business rule and can be scheduled to be sent immediately, on a specic date, or at
an interval in the future.

transfer  
A feature in Chat that enables an agent to transfer a customer to another agent during a chat session.

trending  
A method of predicting a trend for a specied date range in the future based on a report’s current data. Trending
periods are dened when creating or editing a custom report and can be included in standard reports.

trigger  
The part of a script or workspace rule that denes the event that causes the rule conditions to be evaluated and (if
matched) the rule action to occur.

Unqualied  
One of the default chat agent statuses. This status indicates that the agent is not available to chat. The Unqualied chat
agent status has an Unavailable status type.

Unresolved  
One of the default incident status types and statuses. Incidents with an Unresolved status have recently entered the
system, either by a customer or by an agent.

Unrestricted  
One of the default chat agent statuses. This status indicates that there are no restrictions to the agent’s availability to
chat. The Unrestricted chat agent status has an Available status type.
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Unspecied  
One of the default chat agent statuses. This status indicates that the agent is logged out of Chat. The Unspecied chat
agent status has a Logged Out status type and is displayed to agents by default.

Unsubscribe link  
A link in a mailing that contacts can click to opt out of future mailings or surveys.

Updated  
One of the default incident statuses. An incident marked Updated has been updated by a customer from Your Account.
Updated incidents have an Unresolved status type.

Upgrade site  
A site created during the update process. It has the latest version of the software, and data from your current
production site. You can use it to test, congure, and prepare your site for the update.

upgrading  
The process of moving from one release of Oracle Service Cloud to a newer release. See also migration.

Update Management System (UMS)  
A dynamic checklist tool that guides you through a series of tasks that test the core functionality of your updated site.

URL answer  
A type of answer that consists of a link to an external URL. The URL address and the content of the web page are
displayed.
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user agent seings  
The shortcut on the customer portal administration dashboard that allows page set mapping. See also page set
mapping.

User link  
A navigation element on community pages containing links to the logged-in user’s prole, inbox, favorites, and
subscriptions, and a sign-out option.

user type  
The community role of a member account as dened by the nature of actions that the member is permied to take.

utility  
Any of a number of programs in Oracle Service Cloud to help manage and congure an installation. Utilities include
Agedatabase, Bulkdel, Dbaudit, Dbstatus, Kexport, Kimport, Langcvt, Msgtool, Reportgen, Techmail, and Wltool.

validation  
The process of error-checking items such as desktop workows, scripts, rules, advanced surveys, and campaigns. Items
are validated to ensure that all required properties have been completed and that the conguration is functional. Oracle
Service Cloud also validates email addresses for industry-accepted formaing.

variable  
A temporary data item in a rule base. The variable is assigned an initial value that can be modied through rule actions,
used as a rule condition to trigger other actions, and restored to its initial value for the next round of rules processing.
Variables also refer to shortcuts dened for a larger string that can be inserted in the body of an answer or inserted
inline during a chat session. When the variable is inserted in the body of the answer or in a chat response, it is replaced
with the value specied in the variable.
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versioning  
The system of numbering the Customer Portal framework and widgets to denote varying levels of changes. Major
and minor changes are not backward compatible, while nano changes are applied automatically to all Customer Portal
installations.

view partial  
A reusable segment of code for common functionality that can be called from widget views to avoid duplicating the
same code in multiple widget view les.

virtual assistant  
A process of routing incoming chats to a simulated agent that uses knowledge base data to respond to customer
questions. Virtual assistant chats can ease the volume of chats requiring an agent. See Oracle RightNow Virtual
Assistant Cloud Service.

visibility  
A seing that determines where a custom eld or customizable menu item will appear. Visibility seings specify the
interfaces in a multiple-interface installation where these elds appear. The seings can also dene whether the elds
appear on the administration interface and customer portal and whether certain custom elds with customer visibility
can be edited.

visit  
See Web visit.

Waiting  
One of the default incident status types and incident statuses. An incident marked Waiting has been responded to by a
sta member and is waiting for a response from the incident creator.
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web form  
A document in Outreach that allows contacts to input information that can be submied to the database. Web forms are
served as web pages by Oracle Service Cloud.

Web Indexer  
A search method that lets customers simultaneously search the knowledge base along with web pages and other web-
accessible documents within a specied domain.

Web spider  
A software application that visits web sites and reads their pages and other documents in order to create entries for a
search engine index.

web visit  
The period of time a customer spends looking for a satisfactory answer to a question. The end of a web visit generally
occurs when a customer closes the browser or leaves the interface or when a specied time period elapses.

web visit tracking  
A feature that tracks information about a customer’s current web visit. That is, it tracks the pages on the customer portal
that the customer clicked before submiing a question.

website link survey  
A type of survey that is published as a web page and can be linked to from any source.

weight  
A displayed value given to resulting answers of a text search. The value is equal to the sum of the weights (for
indexed words) of all the matched words from the text search. Weight also refers to an internal value given to each
indexed keyword for an answer or incident. The value is relative to a constant and is based on number of occurrences,
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capitalization, and location of the word (ranked high to low: Keywords, Summary, Question, and Answer eld for
answers; Subject eld and incident thread for incidents).

widget  
A collection of les that generates a specic function when it is placed on a page of the customer portal. Widgets can
be buons, elds, reports, or other elements that can access the Oracle Service Cloud database and communicate with
other widgets through events or to the server through AJAX requests.

widget builder  
A tool that generates custom widget code, including placeholders to allow additional editing of the code. The widget
builder, accessed on the Customer Portal Administration site, can extend an existing widget or create a new one.

Win/loss reason  
An option for classifying and recording reasons for winning or losing an opportunity.

Wltool  
A utility that is manually run after making changes to one of the wordlist les. See Wordlist le.

word stemming  
A feature used in keyword indexing and text searching that nds the root of each word and stores the stemmed root
instead of the whole word, thereby saving large amounts of space while making a search broader and more appropriate.

wordlist le  
Any of the les that can be modied to customize indexing, text searching, and SmartSense emotive ratings. See File
Manager.

workow  
See Desktop workow.
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workgroup  
All of a record’s open, associated records (for instance, an incident’s contact, organization, and tasks) that are docked
to the Service Console. All records in a workgroup are saved and closed in a single operation. When another non-
associated record is opened, the records in the workgroup are collapsed on a single content pane tab.

working record  
The record being evaluated or acted upon by a workow element or connector. For instance, a workspace element
can display the rst or last record opened in the workow or a record named elsewhere in the workow. See Desktop
workow.

workspace  
The conguration of the content pane when working with answers, contacts, incidents, opportunities, organizations,
and tasks; when working in Chat; and when working with quotes, quote products, and service opportunities. Standard
workspaces exist for each type of workspace, and custom workspaces can be created. The workspaces sta members
use depend on the workspaces selected in their prole.

workspace rules  
A type of rule used to dynamically adjust the display, behavior, and values of elds and controls on a workspace based
on sta member actions. Each rule is triggered by one or more events and conditions.

Workspace designer  
The tool used to create and edit custom workspaces.

WYSIWYG (what you see is what you get)  
See HTML editor.

Your Account  
A tab on the customer portal that opens the Account Overview page where customers can view and update all the
questions they have previously submied and view any answer or product/category notications to which they are
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subscribed. They can also view their service contracts, edit their account information, and change their password. This
component is restricted and requires a customer account.
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